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 Batch and license plate confirmation
 Enable license plate label printing
 Create transfer orders from the warehouse app
 Piece picking confirmation
 Packing materials and fees
 Set up manual packing (February & May 2016 only)
 Set up short picking item reallocation
 Cancel warehouse work for exception handling
 System-directed work sequencing
 Pick line grouping
 Warehouse slotting
 Location directive inventory picking aging
 Outbound sorting
 Put to wall - put to store
 Outbound workload visualization
 Troubleshoot picking and packing

 Replenishment
 Replenishment overview
 Immediate replenishment
 Replenishment with withdrawal kanbans
 Set up a min-max replenishment process
 Zone threshold replenishment
 Replenishment strategies
 Replenishment over location capacity
 Troubleshoot warehouse replenishment

 Load building and shipments
 Confirm and transfer
 Confirm outbound shipments from batch jobs
 Advanced load building during wave



 Release to warehouse rule
 Wave template grouping
 Reprint and void wave labels
 Small parcel shipping
 Troubleshoot load building and shipments

 Shipment consolidation policies
 Shipment consolidation policies
 Configure shipment consolidation policies
 Scenario 1 - Consolidate shipments when they are released to the warehouse

by using Automatic release of sales orders
 Scenario 2 - Consolidate shipments when the shipment consolidation policy is

overridden from the Release to warehouse page
 Scenario 3 - Consolidate shipments by using Release to warehouse from the

load planning workbench
 Scenario 4 - Consolidate shipments by using the shipment consolidation

workbench
 Scenario 5 - Consolidate shipments manually by using the Consolidate

shipments page
 Troubleshoot outbound warehouse operations

 Across the warehouse operations
 Warehouse work policies

 Work policies
 Movement of inventory with associated work in Warehouse management
 Create a work class
 Manage warehouse workers
 Deferred processing of warehouse work

 Cross-docking
 Cross-docking from production orders to outbound docks
 Auto-release shipment for cross-docking
 Planned cross-docking

 Inventory counting
 Reason codes for inventory counting
 Block inventory
 Cycle counting



 Define cycle counting
 Partial location cycle counting
 Define partial location cycle counting process
 Warehouse management on-hand entries cleanup job
 Inventory journals
 Inventory location
 Inventory status
 Inventory tag counting

 Warehouse work
 Work line details
 Location license plate positioning
 Change work pool on work
 Item consolidation - location utilization
 Troubleshoot warehouse work
 Work split

 Warehouse setup
 Warehouse configuration

 Warehouse configuration overview
 Set up a warehouse by using a warehouse configuration template
 Control work by using work templates and location directives
 Work with location directives
 Configure product filters for warehouse transactions
 Location stocking limits
 Wave step codes
 Configure wave processing
 Schedule work creation during wave
 Set up and use wave label printing
 Auto-update shipments
 Create a location profile
 Configure locations in a WMS-enabled warehouse
 Warehouse location status
 Additional location zones



 Schedule load utilization
 Schedule workload capacity
 Set up dispositions codes
 Unit of measure and stocking policies
 Warehouse Power BI content
 System grouping on an open work list
 Document routing layout for license plate labels
 Mobile barcode support
 Set up warehouse for transfer orders
 Troubleshooting warehouse configuration

 Install and configure the warehouse app
 Install and connect the Warehouse Management mobile app
 Mobile device user settings
 Install and connect the warehouse app
 Scan bar codes using a camera in the warehouse app
 Configure field names in warehouse app
 Set up mobile devices for warehouse work
 Warehouse app event processing
 License plate receiving with the warehouse app
 Set up a mobile device menu item for completing work in a purchase order
 Set up a mobile device menu item to register received items
 Set up a mobile device menu item to provide a pick line overview
 Create a mobile device menu item for license plate consolidation
 Mixed license plate receiving on a mobile device
 Configure Display older batches within warehouse on a mobile device
 Pick oldest batch on a mobile device
 Process guide framework
 Troubleshoot warehouse app connection issues

 Upgrade and migration
 Upgrade Warehouse management processes from Microsoft Dynamics AX

2012 to Finance and Operations
 Troubleshoot upgrade and migration to advanced warehouse management

 Troubleshoot warehouse setup



 Supply Chain Management development
 Gantt control development guide
 Create a new transportation management engine
 Extend inventory on-hand data entities

 Finance and Operations apps development and administration
 Dynamics 365 Finance
 Dynamics 365 Commerce
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What's new and in development

Core concepts and tasks

Dynamics 365 Finance

Videos

This topic provides a list of the help topics and other resources in Dynamics 365 Supply Chain Management.

Go to the Dynamics 365 Roadmap to see what new features are released and what new features are in

development.

Select a feature area to learn more about it.

Asset management

Cost accounting

Cost management

Inventory management

IoT Intelligence

Master planning

Procurement and sourcing

Product information management

Production control

Sales and marketing

Service management

Transportation management

Warehouse management

For information on Dynamics 365 Finance, go to the Finance home page.

This short video summarize the new supply chain management features added to Microsoft Dynamics 365 for

Finance and Operations version 8.0 (April 2018).

Synchronize a work order between Field Service and Finance and Operations

These short videos summarize the new supply chain management features added to Microsoft Dynamics 365

for Finance and Operations, Enterprise edition 7.3 (December 2017).

Prospect to cash integration

Optimization advisor

Use warehouse template to copy configuration

These short videos summarize the new supply chain management features added to Microsoft Dynamics 365

for Finance and Operations, Enterprise edition (July 2017).

Get started with Cost accounting

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/index.md
https://roadmap.dynamics.com/
https://youtu.be/hAB4TDVMjxU
https://youtu.be/AVV9x5x-XCg
https://www.youtube.com/watch?v=MRsAzgFCUSQ&t=4s
https://www.youtube.com/watch?v=K2WIfFlqJYs&feature=youtu.be
https://youtu.be/1pUDtJQZ8FU


Blogs

White papers

eLearning courses

NOTENOTE

Cost control mobile workspace

Use Excel for cost analysis

Approve purchase orders on a mobile device

Visual scheduling with Gantt chart for production and batch orders

The following tech conference recordings discuss supply chain management functionality from previous

versions of Finance and Operations. This functionality is now part of Dynamics 365 Supply Chain Management;

the same concepts still apply, and the procedures are similar in the current version.

Cost management:Cost management:

Master planning:Master planning:

Product information management:Product information management:

Warehouse management:Warehouse management:

Production control videos:Production control videos:

Transpor tation management videos:Transpor tation management videos:

Overview of Cost management

Extend the demand forecasting functionality

Master planning - tips and tricks for troubleshooting performance

Help! MRP is slow!

Product configurator in Microsoft Dynamics AX

Get the best out of your warehouse management system

Dynamics AX 2012 R3: Advanced warehouse management - A day in the life of process

manufacturing

Subcontracting operations and activities in manufacturing

Transportation management (TMS) in the new Microsoft Dynamics AX

There are many topics about manufacturing and supply chain management on the Dynamics AX Manufacturing

R&D Team Blog and Supply Chain Management in Dynamics AX R&D Team Blog. Most of these were written for

the previous version, but the same concepts still apply, and the procedures are similar in the current version.

Lean manufacturing: Capable to promise and kanban job scheduling

BOM calculation by using a costing sheet

For online courses and training, check out Dynamics 365 Supply Chain Management on Microsoft Learn.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://youtu.be/imsuTg8rUVk
https://youtu.be/-HKHYdClvx8
https://youtu.be/gZ-gOlJe7H8
https://youtu.be/BtbuShkGj4I
https://www.youtube.com/watch?v=vXzlC-mOBcg&feature=youtu.be
https://www.youtube.com/watch?v=4OIKIXLiNjI&feature=youtu.be
https://youtu.be/7v8BPmEs9Dg
https://youtu.be/RLXybx20B5o
https://youtu.be/zotrj3SbCl4
https://www.youtube.com/watch?v=--_didmZKHo&t=10s
https://www.youtube.com/embed/QUxXUrN-7n4
https://youtu.be/y1jrd3A_k70
https://youtu.be/jgmTgJIgEFQ
https://blogs.msdn.microsoft.com/axmfg/
https://blogs.msdn.microsoft.com/dynamicsaxscm/
https://docs.microsoft.com/en-us/dynamics/s-e/
https://www.microsoft.com/download/details.aspx?id=101937/
https://docs.microsoft.com/en-us/learn/browse/?products=dynamics-scm&resource_type=learning path
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Step one: Try out Finance and Operations free for 30 days

Step two: Choose a deployment option

IMPORTANTIMPORTANT

Step three: Buy and manage a subscription

Buy through a Cloud solution provider (cloud-only)Buy through a Cloud solution provider (cloud-only)

Buy through a Dynamics partner (on-premises)Buy through a Dynamics partner (on-premises)

New to Dynamics 365 Finance, Dynamics 365 Supply Chain Management, or Dynamics 365 Commerce? We've

put together step-by-step guidance whether you're still evaluating or ready to make a purchase.

You can try Dynamics 365 for Finance, Dynamics 365 Supply Chain Management, or Dynamics 365 Commerce

for 30 days through a simple email signup. The trial version of Finance and Operations applications includes

Getting started task guides that provide step-by-step instructions that allow you to view specific scenarios in

action. The product is available to explore and exercise scenarios, but cannot be customized. Demo data is

included to ease the use of the product and to make the experience more meaningful. A reminder email will be

sent 3 days prior to the trial expiration. Get details at Sign up for preview subscriptions.

You can now deploy Finance and Operations applications in the cloud or on-premises. Cloud deployments offer

an ERP service that is fully managed by Microsoft, while on-premises deployments are deployed locally within a

customer's data center.

The following considerations must be taken when you choose on-premises as a deployment option:

Regulatory and compliance needs that are not available in the cloud certifications.

Disconnected business process with intermittent internet connectivity required to access Microsoft Dynamics

Lifecycle Services (LCS) for application lifecycle management.

Comparison of cloud and on-premises features.

System requirements for on-premises deployments.

On-premises deployments are not supported on any public cloud infrastructure, including Microsoft Azure.

For more information, see Deployment options.

To explore subscription options, go to the Dynamics 365 pricing page. This page includes several different plans

to fit your organization's needs.

There are many ways to buy a subscription:

Buy through a Cloud solution provider (cloud only).

Buy through a partner, and use volume licensing (cloud or on-premises).

Buy through a partner from the Dynamics price list (on-premises only).

A Microsoft Cloud Solution Provider can work closely with you to understand the needs of your business or

organization. Use the Microsoft Partner Center portal to find a partner to fit your needs.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/before-you-buy.md
https://www.microsoft.com/dynamics365/pricing
https://partnercenter.microsoft.com/partner/home


Buy through volume licensing (cloud or on-premises)Buy through volume licensing (cloud or on-premises)

Choose your support optionChoose your support option

Step four: Learn about FastTrack and plan your deployment

If you are upgrading from Dynamics AX 2012 or migrating from AX
2009

NOTENOTE

You must work with a partner to purchase Finance and Operations on-premises. For more information, see Buy

Finance + Operations (on-premises).

If your organization has 250 or more Dynamics 365 users, you may be interested in a Volume licensing

agreement.

In volume licensing, Finance and Operations applications are available through:

Enterprise Agreement

Enterprise Agreement Subscription

Enrollment for Education Solutions (under the Campus and School Agreement)

Microsoft Products and Services Agreement (MPSA)

Microsoft provides flexible, industry-leading support, services, and resources that enable users to quickly

address technical issues and maximize return on your Dynamics 365 investment. Choose a plan that best meets

your business requirements.

For additional resources, see:

Dynamics 365 Support

Quick Start Guide for Microsoft Dynamics Cloud Service Support Benefits (PDF)

Microsoft FastTrack for Dynamics 365 is our customer success service designed to help you move to Dynamics

365 smoothly and confidently, so you can realize business value faster. When you participate in the FastTrack

program, you will receive guidance on best practices and how to plan for successful rollouts. You will also learn

ways to enable new users and expand capabilities – all at your own pace. Additionally, you will have access to

Microsoft engineering resources committed to make your experience with Dynamics 365 a success. For more

information, see Microsoft FastTrack.

If you are a customer who is upgrading from Microsoft Dynamics AX 2012 or migrating from Microsoft

Dynamics AX 2009, you may be eligible for a longer trial. Contact daxcf@microsoft.com for more information.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://www.microsoft.com/Licensing/product-licensing/dynamics365
https://www.microsoft.com/dynamics365/support
https://go.microsoft.com/fwlink/?LinkId=530335
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/fasttrack-dynamics-365-overview.html
mailto:daxcf@microsoft.com
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Sign up for preview subscriptions
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Key terms

This topic explains how to subscribe to the preview/partner offer and deploy an environment. The subscription

that you create gives you a Microsoft Online Services test tenant and a Microsoft Dynamics Lifecycle Services

(LCS) project where you can deploy an environment. This topic will also help you set up additional users in your

Microsoft Online Services tenant and gain experience with service administration capabilities. Here are the skills

that you will learn:

Subscribe, and create a new Microsoft Online test tenant.

Navigate to LCS projects.

Use various features of LCS.

Add users to Microsoft Azure Active Directory (Azure AD) and the client.

View resources in your subscription email.

IMPORTANTIMPORTANT

Microsoft Online Ser vices tenantMicrosoft Online Ser vices tenant – A tenant is the group of all subscriptions and users for your

organization. The tenant is created at the same time as your first subscription in Microsoft Online

Services.

Subscr iptionSubscr iption – A subscription gives you an online cloud environment and experience. It also lets you see

how customizations that you develop can be deployed to the cloud.

Microsoft Azure Active Director yMicrosoft Azure Active Director y  – The cloud environment includes Azure AD. Azure AD helps you

manage users, groups, security roles, and licenses for online applications, much as you manage them for

on-premise environments.

UsersUsers  – Users of the services that your organization has subscribed to are managed in Azure AD. Any

users in your tenant can be added and assigned to security roles.

Developers and administratorsDevelopers and administrators  – Developers and administrators are users who also have access to

LCS that lets them manage projects and environments. These users are also end users.

Organizational accountOrganizational account – Users receive Azure AD credentials. These credentials are separate from

other desktop or corporate credentials. The Azure AD credentials are used to sign in to Microsoft 365 and

other Microsoft cloud services. Users sign in by using their organizational account.

For this release, we ask that you not use any existing credentials that are associated with other online services,

such as Microsoft 365 or Microsoft Dynamics CRM Online.

Microsoft accountMicrosoft account – Microsoft accounts were formerly known as Passport accounts or Windows Live ID

accounts. Currently, Microsoft accounts can't be used with Finance and Operations applications, Microsoft

Dynamics 365 Commerce, or other Microsoft Online Services. However, Microsoft accounts are still

required for Microsoft Connect and other Microsoft Business Solutions sites, such as CustomerSource,

PartnerSource, Information Source, and Microsoft Dynamics Community. You will continue to use your

Microsoft account to access these services.

Microsoft 365 admin centerMicrosoft 365 admin center  – Microsoft 365 admin center is the subscription management portal

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/dev-tools/sign-up-preview-subscription.md


  

Prerequisites

Subscribe

IMPORTANTIMPORTANT

Start a new project in LCS

that Microsoft 365 provides for administrators. Microsoft 365 admin center is used to provide

management functions for users and subscriptions.

EnvironmentsEnvironments  – You can deploy as many single instances of a virtual machine (VM) as you require. We

call these instances environments.

1. You've received an email that invites you to participate in the preview.

2. If your company has an organizational account with Microsoft Online Services, and you're signed in, you

must sign out before you continue. Alternatively, you can use InPrivate BrowsingInPrivate Browsing mode.

3. If you aren't sure whether you're signed in, delete your browser cookies, and then close your browser before

you continue.

Only one person (tenant administrator) in an organization must perform this task. If you aren't the person who is

subscribing to this release, wait until your organization has been signed up and you've received your user credentials.

Then continue with the procedure.

1. Finance and Operations applications and Retail are available only to existing Microsoft Dynamics 365

channel partners and customers who are currently enrolled in the Business Ready Enhancement Plan

(BREP) service plan. To subscribe, visit PartnerSource Business Center.

2. On the Account setupAccount setup page, in the Countr y or regionCountr y or region field, select the country or region.

3. Follow the wizard and prompts to complete the sign-up, until you reach the last step.

To use LCS to manage your environments, you must create a new project.

1. Go to https://lcs.dynamics.com/Logon/Index.

2. Select S ign inSign in .

3. Sign in by using the account that you used to subscribe.

4. Select the plus sign (++) to create a new project.

https://businesscenter.mbs.microsoft.com/#contentdetail/Microsoft_Dynamics_AX_Public_Preview
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/dev-tools/media/wizardprompt.png
https://lcs.dynamics.com/Logon/Index


Add users to LCS

5. Select the project type.

6. Enter the project information, and then select CreateCreate.

If you plan to evaluate Commerce, be sure to select Microsoft Dynamics 365 CommerceMicrosoft Dynamics 365 Commerce in the

Product nameProduct name field.

The new project for managing your instance is created.

You're already set up as a user of your LCS project. If you've also added other Microsoft 365 users, you must add

them to this project. Other administrators and developers will then be able to deploy their own environments.

These LCS users are team members who will actively work on the implementation. Don't confuse them with end

users. Start on the project page in LCS.

1. Scroll to the right, and then, in the More toolsMore tools  section, select the Project usersProject users  tile.

2. In the upper left, select the plus sign (++) to add a new user.

3. In the EmailEmail  field, enter the email address of the user that you're adding. This email address should be the

Microsoft 365 organization email address that you created earlier.

4. In the Project roleProject role field, select Project OwnerProject Owner .

5. Select InviteInvite.

6. Repeat steps 2 through 5 for all users in your organization.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/dev-tools/media/11.jpg


Deploy environments

NOTENOTE

Environments should be deployed to an existing Azure subscription.

Each developer of an environment must deploy their own system to Azure. However, only the first project user must set

up the Azure subscription for deployment.

You can create environments in two ways:

Deploy to Microsoft cloud services (Azure).

Download a local virtual hard disk (VHD).

Start on the project page in LCS.

NOTENOTE

1. In the EnvironmentsEnvironments  section, select the plus sign (++). The Microsoft Azure setupMicrosoft Azure setup dialog box appears.

2. Enter your Azure subscription ID. You can find your Azure subscription ID in Azure Portal

(https://ms.portal.azure.com/), under SettingsSettings  in the lower left.

3. Select NextNext.

4. Download the Azure Management Certificate to a local folder on your computer, and then upload it to

Azure Management Portal by going to SettingsSettings  > Management Cer tificatesManagement Cer tificates . This certificate will

enable LCS to communicate with Azure on your behalf.

5. Return to LCS, and select NextNext.

6. Select the Azure region to deploy in. The West USWest US  region will have the fastest deployments, but it's

important that you select a data center that is close to where you plan to use this system.

7. Select ConnectConnect.

8. In the list of available topologies, select the topology to deploy. You can select either the DownloadDownload link

to download the VHD or NextNext to deploy on Azure. Azure is the preferred path.

9. Enter the name of the environment.

10. Read the pricing and licensing terms, and then select the check box to indicate that you understand them.

11. Select NextNext.

12. Confirm the details, and then select DeployDeploy .

Developers and administrators who will use their own environments must sign in and repeat these steps.

After you deploy your environment, it's available in the EnvironmentsEnvironments  section.

https://ms.portal.azure.com/


Use the features of LCS

Explore the LCS projectExplore the LCS project

13. Select the environment to view details about the deployment status. The first deployment will require a

few hours, but each subsequent deployment will be much faster.

14. When the deployment status changes to DeployedDeployed, select LoginLogin to connect to the client, or select the

name of the VM to connect to the development machine by using Remote Desktop. After the deployment

is completed, you can find the base URL and the information that you require to connect to the

environment via Remote Desktop.

LCS is the starting point for performing online administrative activities. Here are some of these activities:

Deploy VMs on Azure.

Access materials.

Access downloads of tools and resources.

1. Review the methodology, and complete the tasks and phases as you progress through the life cycle. The

phases and task information lets you view tools and resources that are available throughout your

enterprise resource planning (ERP) experience.

2. Scroll to the right, and review the tiles.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/dev-tools/media/pic7.jpg
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The available tiles include various tools and services in LCS. They also include the following additional

tiles:

NOTENOTE

NOTENOTE

My subscr iptionMy subscr iption – The Microsoft 365 subscription management portal is where you can view

and work with your online subscriptions. By selecting User and GroupsUser and Groups  in the left navigation

section of the page, you can also manage your online users.

To access the page, you must be a member of the Global AdministratorGlobal Administrator  role for your organization's

Microsoft Online Services tenant.

Feedback and bugsFeedback and bugs  – This tile opens the General FeedbackGeneral Feedback page in Microsoft Connect. Use

this page to record bugs, and to design change requests, feature requests, and suggestions.

Microsoft 365 usersMicrosoft 365 users  – This tile opens the Users and groupsUsers and groups  page in Microsoft 365 admin

center. You can add, update, and remove users, reset passwords, and assign licenses for other

services.

To access the page, you must be a member of the Global AdministratorGlobal Administrator  role for your organization's

Microsoft Online Services tenant. The installing user is always a global administrator, but other users must

be added to this role.



NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/dev-tools/media/activeusersadmin.png
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Configure

The following set of topics provide information that is related to service updates for Microsoft Dynamics 365 for

Finance and Operations version 8.1 (October 2018) and later. This is applicable for cloud releases only.

Service update availability – This topic provides information about the release cadence and release process.

Software lifecycle policy and cloud releases – This topic provides information about the service updates,

availability, and end of service.

One Version service updates FAQ – This topic answers questions about the update process, tools, planning,

and Retail service updates.

The experience for service updates consists of four distinct steps:

1. Configure

2. Notice

3. Update

4. Validate

The rest of this topic describes each step and provides links to related topics.

Customers can select a maintenance window, based on their business constraints. In Microsoft Dynamics

Lifecycle Services (LCS), use the fields in the Production environment update cadenceProduction environment update cadence section on the

Update settingsUpdate settings  tab of the Project settingsProject settings  page, as shown in the following image. A calendar of upcoming

updates is available to help you plan ahead.

Users must opt in to new features and turn them on. All updates are applied first to the user acceptance testing

(UAT) environment and then to the production environment. Therefore, customers have time to do any

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/lifecycle-services/oneversion-overview.md
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/media/updatesettings-configureupdates.jpg


Notice

Update

validation that is required. Customers can select the environment that is updated. They can also pause an update

for up to three months.

Release plans will be available to help you plan ahead and understand what is changing. You can learn about

upcoming features up to three months in advance. The What's new topics provide details about the updates for

specific months.

Additionally, a notification email will be sent five days in advance, and a notification will appear in LCS just

before an update, as shown in the following illustration.

After notifications have been sent, Microsoft will apply the update (auto updateauto update) during the designated

maintenance window. After this operation is completed, a notification email will be sent to indicate the status of

the update. Customers will also be able to self-updateself-update by using the standard update experience in LCS. For

more information, see Apply updates to cloud environments.

Customers who participate in the First release program will have an opportunity to update their sandbox

environment and other environments early. To sign up for the First release program, go to

https://experience.dynamics.com.

Customers will also be able to self-updateself-update by using the standard update experience in LCS, as shown in the

following illustration.

https://docs.microsoft.com/en-us/business-applications-release-notes/april19/dynamics365-finance-operations/
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-changed
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/media/notification-bar.png
https://experience.dynamics.com
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/media/self-update-execute.jpg


Validate

NOTENOTE

After an update is completed in the UAT environment, a basic business process test can be executed to validate

the environment. To support this effort, a no-code automation test tool for business process testing is available,

as shown in the following illustration. For more information, see Create and automate user acceptance tests.

Some customers have both external data integrations and internal data integrations. We recommend that these

customers use the Data task automation tool for testing.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/media/testautomation.png
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Can the update be delayed, what is the policy?Can the update be delayed, what is the policy?

With a release date in early April, when will the general availability package be made available?With a release date in early April, when will the general availability package be made available?

Service updates
What product versions are impacted by service updates?What product versions are impacted by service updates?

VERSIO NVERSIO N DESC RIP T IO NDESC RIP T IO N

8.1 and later All customers on 8.1 and later will be scheduled for
automatic monthly updates with a combined application and
platform update starting November 2018. You will be
required to be on an update that's no older than 4 months
or 3 service updates. To pause an update, refer to Pause
service updates.

8.0 Customers on 8.0 can manually apply the monthly platform
and financial reporting updates. You will be required to have
an update that's no older than 4 months or 3 service
updates. The 8.0 application lifecycle ends in April 2019.
Customers on 8.0 must update by April 30, 2019 to stay
supported. In order to be on a supported application,
customers should follow the process to update to the latest
version. For more information, see Update environments
from version 8.0 to 10.0.X.

In July 2018 we announced a change to the way we deliver Dynamics 365 updates that will help you stay

current in a consistent, predictable, and seamless manner. In June 2019, based on customer feedback we

announced New flexible service updates being made available. This FAQ is intended to provide clarity on the

service updates, processes, and tools you can use to prepare for it. We will continue to add additional

information to this topic as needed.

Yes, the customer can pause, delay, or opt-out of an update via Update Settings in the Lifecycle Services projects.

A customer can choose to pause up to 3 consecutive updates. The following is an example of a delayed update:

The customer is currently on version 10.0.2.

The customer can pause updates 10.0.3, 10.0.4, and 10.0.5.

The customer must take the 10.0.6 update when it is available.

Production updates for a monthly release will be scheduled for the first, second, and third weeks in of the

month. Depending on the configuration that you set up in Lifecycle Services (LCS), you will receive updates

during that specific week.

For the April 10.0 release, Microsoft will perform updates during the weekends of April 6, April 13, or April 20

based on the configuration that you set up in LCS. Sandbox updates will always be scheduled a week before the

update. The configuration setup is available in LCS.

Customers can always choose to apply the update at an earlier time, or if there is a more convenient time than

the suggested times in Lifecycle Services. If the customer is on the latest version the auto update will be

canceled.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/one-version.md
https://cloudblogs.microsoft.com/dynamics365/2018/07/06/modernizing-the-way-we-update-dynamics-365/
https://cloudblogs.microsoft.com/dynamics365/bdm/2019/06/03/new-flexible-service-updates-for-dynamics-365-for-finance-and-operations/
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/lifecycle-services/pause-service-updates
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/migration-upgrade/appupdate-80-81


7.x Customers on 7.x can manually apply the monthly platform
and financial reporting updates. You will be required to have
an update that's no older than 4 months and 3 service
updates. Customers on 7.x must update by April 30, 2019 to
stay supported. If customer stays on version 7.3 past April
30 they will still receive automated platform updates every
month. You are required to upgrade to 8.1 by April 2019
(unless extensions are not available). The only overlayered
version in market will be version 7.3.

VERSIO NVERSIO N DESC RIP T IO NDESC RIP T IO N

What does the service update contain?What does the service update contain?

What is a regulatory update?What is a regulatory update?

What's the upcoming schedule of updates?What's the upcoming schedule of updates?

Are there any major updates post 8.1?Are there any major updates post 8.1?

What does it mean when an update is backward compatible?What does it mean when an update is backward compatible?

Can I apply a Platform service update to my existing 8.1 or later environments?Can I apply a Platform service update to my existing 8.1 or later environments?

For release 8.1 and later, service updates will contain application (including financial, reporting, and Commerce)

and platform changes that are critical improvements to the service including regulatory updates. New

experiences will be configurable. The service updates are backward compatible. There will be a single version

representing this update.

A regulatory update is a new feature or an existing feature change required by law (usually for a specific

country/region). The regulatory update is always required by a specific law enforcement date (LED) and should

be enabled by this date or earlier.

Service updates are available since November 2018. You have the option to apply the update when it is

convenient for you, or let Microsoft auto-apply the service updates based on the selected maintenance window.

You are required to have an update no older than 4 months.

To see a targeted release schedule, see Service update availability.

There will be 2 major updates in April and October where new experiences can be enabled. Major updates will

not require code or data upgrade. Breaking changes will be communicated 12 months in advance such that

customers can plan accordingly. Such a change will only be introduced during a major update. The 10.0 release,

which will be available in April 2019, will also be an update and not an upgrade.

Backward compatibility covers binary and functional compatibility. Binary compatibility means that you can

apply an update on any runtime environment without needing to recompile, reconfigure, or redeploy

customizations. This also means that on a development environment at design time, X++ public and protected

APIs and metadata are not modified or deleted. If Microsoft needs to break compatibility by removing obsolete

APIs, it will be communicated 12 months in advance and follow a deprecation schedule. Functional compatibility

is about user experience, all new experiences will be opt-in for a 12-month period.

Backward compatibility does not include non-X++/metadata APIs. Microsoft reserves the right to update

versions of any dependencies the product uses, as well as remove dependencies without early warning.

Microsoft does not commit to maintain backwards compatibility of dependent software libraries unless

expressly stated.

For more information on deprecation guidelines and deprecated methods and metadata elements, see

Deprecation of methods and metadata elements.

Customers on version 8.1 or later will only be able to apply the 8.1.x or v10.x Service updates. Platform only

service updates cannot be applied to version 8.1.x or later. Platform service updates can only be applied to

versions 7.x or 8.0.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/migration-upgrade/deprecation-deletion-apis


Will Platform updates be able to be scheduled and delay/pause by customers?Will Platform updates be able to be scheduled and delay/pause by customers?

Service updates for on-premises deploymentsService updates for on-premises deployments

Process
How will Microsoft ensure quality of releases?How will Microsoft ensure quality of releases?

Can I select the day and time to update?Can I select the day and time to update?

A service update was applied to the environment, when looking at the tile in Lifecycle Services for thisA service update was applied to the environment, when looking at the tile in Lifecycle Services for this
environment what does the number on the tile represent?environment what does the number on the tile represent?

How do I update to the latest version?How do I update to the latest version?

How do I update the production environment to the same version after Microsoft updates the sandboxHow do I update the production environment to the same version after Microsoft updates the sandbox
environment?environment?

What is the expected downtime?What is the expected downtime?

What's the process for deprecation?What's the process for deprecation?

Yes, customers who are on version 7.3 are able to schedule platform updates directly in Lifecycle Services. A

delay/pause experience is also available.

The policy and schedule for service updates are now the same for both cloud and on-premises deployments.

This includes, for example, the option to delay applying up to 3 consecutive updates. How to apply each of these

updates remains slightly different. For more information, see Apply updates to on-premises deployments.

Ensuring quality of the release is a fundamental principle that's enabled through a series of progressive,

rigorous, automated validations as described in Service update availability.

Customers can configure the day and maintenance time windows in LCS. The service update, which is based on

your update settings, will start within 15 minutes. Email will be sent to customers who opt in to receive LCS

notifications with instructions included on how to update. Customers will be able to select the designated tier

2/UAT sandbox for the update. Customers will have 7 calendar days for testing and validation.

Customers can optionally choose to apply the update earlier to all environments through LCS. The production-

ready, deployable package will be made available to all customers via the Action Center in Lifecycle Services.

Customers are responsible for deploying the update to any additional sandbox or developer/build (tier 1)

environments. For more information, see Configure service update.

The same service update will be auto applied to all customers by Microsoft. Microsoft will continue to service

the latest update. The tile in LCS for that environment represents the cumulative number of hotfixes that are

available to be applied to your environment. Because Microsoft will only auto apply the same version to all

customers, you will be responsible for apply the cumulative hotfix package if it is required.

Users can update to the latest version using the tiles on the Environment details page in LCS. After the update is

released by Microsoft, the tile will show the update available. Customers can choose to apply the update on their

own by going through the update experience on their sandbox and production environments.

When Microsoft updates a sandbox environment, the package that is used for the update is saved in the

project's asset library. The name of the package is prefixed by the words "Service Update." Because the package

was already applied to the sandbox environment, you can mark this package as a Release Candidate. You can

then go to the production environment and schedule to apply the package, just as you might schedule to apply

any other update.

The expected downtime for a successful update is 30 minutes to 1 hour. However, we ask for three hours of

downtime in case issues occur while the update is applied. We are actively working to reduce the downtime that

is required, and you should expect improvements in the next few months.

Before any feature is removed from the product, the deprecation notice will be announced in the product

documentation 12 months prior to the removal.



Can I delay an update?Can I delay an update?

Can I delay an update for longer than 3 consecutive service updates due to seasonal activity or other businessCan I delay an update for longer than 3 consecutive service updates due to seasonal activity or other business
reason?reason?

What if I find an issue during the sandbox update?What if I find an issue during the sandbox update?

What if I find a critical issue during sandbox testing and I am not able to pause the Production auto update?What if I find a critical issue during sandbox testing and I am not able to pause the Production auto update?

How much time do I get for validation?How much time do I get for validation?

What happens when the service update is complete?What happens when the service update is complete?

If there is a failure, can I reschedule the update to be auto applied?If there is a failure, can I reschedule the update to be auto applied?

Will critical hotfixes be automatically applied to my sandbox/ production environment during auto-update?Will critical hotfixes be automatically applied to my sandbox/ production environment during auto-update?

How will my ISVs stay current?How will my ISVs stay current?

For breaking changes that only affect compilation time, but are binary compatible with sandbox and production

environments, the deprecation time will be less than 12 months. Typically, these are functional updates that need

to be made to the compiler.

You can pause an update up to 4 months or 3 consecutive service updates by way of LCS configuration. After

this period, an update will be scheduled and auto-applied by Microsoft. The update experience for a delayed

update will incur additional downtime.

No, service updates will be automatically applied to the sandbox, then 7 days later the update will be applied to

the production environment if the environments are more than 3 service updates old. A customer can only

pause up to 3 consecutive updates in a row. For example, if a customer on version 10.0 chooses to pause

updates 10.0.1, 10.0.2, and 10.0.3 then service update 10.0.4 will be auto applied to the sandbox.

If you find an issue when doing validations in a sandbox environment, you can request to skip the update

through LCS directly by providing a valid support ticket number and a business justification.

Critical issues should always be submitted to the support team via Lifecycle Services as soon as they are

identified. The support staff will work with you on the resolution to the critical issue.

You will get 7 calendar days for validation after the update is applied to your sandbox environment. If you need

more time, you can access the deployable package via the action center in Lifecycle Service and apply to your

environments. This will provide you with additional time to test the update prior to a production roll-out.

Once the service update is applied by Microsoft you will receive a notification if the update was successful or if it

was not able to be applied. There can be several reasons an update was unable to be applied:

Pending Package Sign-off - If a package is pending signoff, Microsoft will not apply the service update to

production.

Deployment Failure - If there was a deployment failure, the environment will be rolled-back to the original

state.

You will not be able to reschedule the update per se, but you may apply the package when it is convenient for

you, just as you might schedule to apply any other update.

The service update that will be made generally available, and auto applied to all customers will contain hotfixes

and potentially new functionality. If a critical issue is reported after the service update has been applied,

customers can pull that cumulative hotfix update from the tile in Lifecycle Services.

Service updates to customer environments will be backward compatible and no action is required by the

Independent software vendors (ISVs). ISVs develop on the minimum required platform release that their code

depends on. Breaking changes will have a 12-month lead time to enable ISVs to include and validate. We

recommend that the ISVs be part of our Partner early access program, so that they can get early access to the

platform bits and validate their solutions against the update before it's made generally available.

https://experience.dynamics.com/insider/


What about new features?What about new features?

Are batch jobs suspended during a service update?Are batch jobs suspended during a service update?

Tools
How can I get early access to non-released platform updates?How can I get early access to non-released platform updates?

Is there tooling available to support testing the latest release?Is there tooling available to support testing the latest release?

How can I test and validate that the integrations continue to work?How can I test and validate that the integrations continue to work?

How can I determine what's changed in a service update?How can I determine what's changed in a service update?

How will I know if there is a deprecated feature that will impact me if I’m not doing active development/How will I know if there is a deprecated feature that will impact me if I’m not doing active development/
recompile my code?recompile my code?

Preparing for One Version
How can I log an extensibility request?How can I log an extensibility request?

All new features will be opt-in for a 12-month period and will not require any change management until you

choose to enable the feature.

Batch jobs are suspended during the maintenance windows and resume when the maintenance is completed.

You can join the First release program, where Microsoft will keep your system always current with the latest

updates. If you are not already a member of the Dynamics 365 Insider Program, you will need to:

1. Sign up for the Insider Program using this URL: https://experience.dynamics.com

2. Accept the terms and conditions to become a Dynamics 365 Insider.

3. After your application has been approved (approximately 24 hours) you can then sign back into the Insider

Portal to find the different preview programs available for you to join.

4. Preview Early Access Program (PEAP) and First Release: The program requires that you accept additional

terms and conditions to join. Please look for these programs within the Dynamics 365 Insider Program after

your nomination has been accepted.

The Regression Suite Automation Tool is available now. This tool significantly reduces the time and cost of user

acceptance testing. User acceptance testing is typically required before taking a Microsoft application update or

applying custom code and configurations to your production environment. It enables functional power users to

record business tasks using the Task recorder and convert them into a suite of automated tests without the need

to write source code. Test libraries are stored and distributed in Lifecycle Services using the Business Process

Modeler (BPM) libraries and fully integrated with Azure DevOps for test execution, reporting, and investigation.

Test data parameters are decoupled from test steps and stored in Excel data files.

Data task automation lets you easily repeat many types of data tasks and validate the outcome of each task. You

can also use automated testing of data entities by using task outcome validation. For more information, see the

Data task automation topic.

The What’s new or Changed documentation is the primary source for the details contained in each service

update. The Release plans are the primary source of information for all new features and changes for a future

release. Features will also include help topics in docs.microsoft.com as needed. An impact analysis tool will be

available in LCS to help you better understand the impact om the features that you use.

Deprecated features will be documented with each release. For more information, see Removed or Deprecated

features.

Extensibility requests can be logged in LCS. Details are available in the Extensibility requests topic. Please note

the following timelines to log and use the available extensions.

https://experience.dynamics.com/insider/
https://experience.dynamics.com
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/lifecycle-services/using-task-guides-and-bpm-to-create-user-acceptance-tests
https://www.microsoft.com/download/details.aspx?id=57357
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/data-entities/data-task-automation
https://docs.microsoft.com/en-us/business-applications-release-notes/
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/migration-upgrade/deprecated-features?toc=/fin-and-ops/toc.json
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/extensibility/extensibility-requests


DAT EDAT E EXT EN SIB IL IT Y  REQ UEST SEXT EN SIB IL IT Y  REQ UEST S

January 2019 All extensibility requests must be logged by January 1, 2019.
ISVs and customers are requested to analyze the code and
make these requests by this time. We will not provide
exceptions to stay on 7.3 after April 2019, if the request has
not been filed by January 1, 2019.

December 2019 Extensions will be available on/ before December 31, 2019
for the requests logged by January 1, 2019. Customers
using these extensions are required to move to current
version by April 2020.

What does end of service mean?What does end of service mean?

Will individual hotfixes be supported?Will individual hotfixes be supported?

Will you notify me about critical hotfixes released for the monthly update that I’m on?Will you notify me about critical hotfixes released for the monthly update that I’m on?

How can I upgrade to 8.x?How can I upgrade to 8.x?

Commerce service updates
What options are available to minimize impact to my Commerce cloud components?What options are available to minimize impact to my Commerce cloud components?

Will there be options to take individual hotfixes for my commerce solution components?Will there be options to take individual hotfixes for my commerce solution components?

What are the maintenance downtime requirements that may impact channel operations?What are the maintenance downtime requirements that may impact channel operations?

When will I need to update my in-store components?When will I need to update my in-store components?

Microsoft will not provide any fixes to issues on versions that have reached end of service. Microsoft will also

not investigate or troubleshoot any issue that you may encounter on a version that's older than 3 service

updates. If you encounter an issue on a version that has reached end of service, you will be required to update

to the latest update and report the issue if it persists.

All environments will continue to be operated by Microsoft. All automatic processes around your environments,

such as monitoring or self-healing, will also continue as long as the environment is on a supported version.

Individual hotfixes will not be supported after 8.1. Customers must update to the latest cumulative update

available to apply the fix (such as 8.1.1). Critical fixes will also be cumulative and available through the LCS

servicing experience.

Customer reported issues are searchable via Lifecycle Services Issue Search. You can sign up to be notified when

an open issue is resolved.

Refer to the Process for moving to the latest update topic to learn how to upgrade to the latest application.

Updating from 8.0 to 8.1 will not require any data upgrade and will be a self-serve update with much reduced

downtime.

Commerce cloud components will require the same down time as your Dynamics 365 headquarters. In an

upcoming release, the Retail Cloud Scale Unit (RCSU) will be available to reduce and further schedule updates to

your deployment. Please refer to our published release information on our documentation and release notes

sites for additional details on RCSU.

All fixes and updates for commerce components will be cumulative.

For retailers with a business need for redundancy, Modern POS offline capability allows core POS operations to

be available for use while disconnected from the internet or while the cloud environment is being updated.

Stores operating with Commerce Scale Unit will also continue to operate with support for core POS operations

during cloud maintenance windows. For more information, see Online and offline point of sale (POS)

operations.

https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/migration-upgrade/upgrade-latest-update#scenario-3-upgrade-to-the-latest-application-release-1
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/migration-upgrade/appupdate-80-81
https://docs.microsoft.com/en-us/business-applications-release-notes/october18/dynamics365-retail/planned-features
https://docs.microsoft.com/en-us/business-applications-release-notes/#pivot=products&panel=products1
file:///T:/eiye/ac1a/dynamics365/retail/pos-operations.html


Will there continue to be backward compatibility for the in-store components?Will there continue to be backward compatibility for the in-store components?

What options are available for updating in-store components across my organization?What options are available for updating in-store components across my organization?

What options do I have to slowly enable new functionality across my channels?What options do I have to slowly enable new functionality across my channels?

NOTENOTE

All in-instore components must be running released software that is less than one year old in order to maintain

support. Customers are responsible for updating self-hosted components (such as components installed in

stores or in privately managed datacenters) and ensuring that the installed versions of these components are

actively supported.

Updates to components hosted in the cloud will continue to preserve backward compatibility with component

versions self-hosted by the retailer (such as components installed in stores or in privately managed datacenters

- Modern Point of Sale, Commerce Scale Unit, Hardware Station) for 12 months after the release date for that

version. Self-hosted components do not need to be updated at the same time as cloud-hosted components and

can be updated on a separate cadence allowing time to roll out updates to stores.

Customers can choose to update self-hosted components manually at each store or use mass update tools such

as Microsoft System Center Configuration Manager, Microsoft Intune, etc.

Microsoft provides several mechanisms to progressively roll-out and enable functional enhancements across

stores, devices, and users.

Screen layout designerScreen layout designer  – Most visual elements in POS are configured and centrally managed by an

administrative user in the customer organization. This means that new POS operations will not automatically

be displayed on POS unless explicitly configured for inclusion in corresponding screen layouts. Screen

layouts are configured using Screen layout designer and can be specific to a store or POS device. For more

information, see Screen layouts for the point of sale (POS).

Functionality profiles, POS permissions, Commerce parametersFunctionality profiles, POS permissions, Commerce parameters  – Significant elements of

functionality in POS are typically configurable by the user. This can be configured through functionality

profiles, POS permissions, commerce parameters, or other controls which allow for device, register, store, or

user-level functionality control in applicable scenarios.

Modern Point of Sale and Commerce Scale UnitModern Point of Sale and Commerce Scale Unit – Because Modern Point of Sale and Commerce Scale

Unit are self-hosted by the retailer, topologies which include either of these components enable roll out of

updates at a separate (and slower) cadence, and in a more granular fashion than with cloud-only topologies.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/retail/pos-screen-layouts.html
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Manage Finance and Operations updates and your
custom code lifecycle
2/18/2021 • 19 minutes to read • Edit Online

This topic describes application lifecycle use cases for Finance and Operations implementations. It's focused on

the following scenarios:

Managing your source code development branches

Applying the next version of a Microsoft service update

Applying a new version of your custom code

This topic applies to Microsoft Dynamics 365 Finance, Dynamics 365 Supply Chain Management, Dynamics 365

Commerce, and Dynamics 365 Project Operations.

The main goal is to show how to complete the following tasks:

Stay up to date and manage Microsoft service updates (or quality updates) for Finance and Operations apps

(including Dynamics 365 Commerce) in incremental phases, independently of the lifecycle of your own

customization. This approach simplifies the update process, and reduces the cost and risk of regressions that

are associated with all-in-one upgrade projects.

Take advantage of source code branches for version control of your custom code. By using version control,

you can isolate the rollout of critical changes and hotfixes from the development of new features and

capabilities.

This topic doesn't explain how to use the different tools in Azure DevOps and Microsoft Dynamics Lifecycle

Services (LCS). Instead, it's focused on processes and best practices. The Apply the next version of a Microsoft

service update and Apply a new version of your custom code sections contain both an overview of the phases

and the steps of the process.

This topic includes the following sections:

Environments

Environments that run your current release

Environments that run the next version of your custom code

Manage source code branches

Apply the next version of a Microsoft service update

Backward compatibility of Microsoft updates

Runtime compatibility

Design-time compatibility

Phase 1: Update the Finance and Operations implementation

Track 1: Update your runtime environments

Update Test 1

Update UAT

Update Prod

Track 2: Update your development environments

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/migration-upgrade/update-guide.md


 

  

Environments

Environments that run your current releaseEnvironments that run your current release

Error situations

Case 1

Case 2

Case 3

Phase 2: Update CSU to version 10.0.11

Phase 2 prerequisites

Track 1: Update your CSU runtime environments

Update Test 1

Update UAT

Update Prod

Track 2: Update your development environments

Phase 3: Update POS to version 10.0.11

Phase 3 prerequisites

Update your Commerce development environment

Option 1: Store component updates that include only runtime changes

Option 2: Store component updates that include runtime and custom changes

Update Process

Update Test 1

Update UAT

Update Prod

Apply a new version of your custom code

Create a hotfix of your code

Update your custom code from release N to release N+1

Upload, update, and deploy store components

This section describes the collection of Finance and Operations environments that the application lifecycle

management (ALM) scenarios in this topic rely on. This configuration is typical for organizations that have

implementations that rely on custom code (extensions). This custom code includes customizations that are

provided by independent software vendors (ISVs).

The following environments are the environments in your current release:

Dev 1Dev 1  – A development environment that runs the same version of Finance and Operations apps as the

production environment. The Dev 1 environment uses Azure DevOps for version control of custom code.

It's connected to the current release branch of your custom code. For more information, see the Manage

source code branches section.

There are many options for development environments, both cloud and on-premises. For more

information, see Deploy and access development environments.

For build automation, use the new Azure DevOps Hosted Agents functionality. For more information,

see Build automation that uses Microsoft-hosted agents and Azure Pipelines.

Test 1Test 1  – A Tier-1 test environment that is used for functional and configuration testing. The Test 1

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-tools/access-instances
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-tools/hosted-build-automation


  

   

Environments that run the next version of your custom codeEnvironments that run the next version of your custom code

Manage source code branches

environment runs the same version of Finance and Operations apps as the production environment. It

also runs the latest release version of your custom code extensions.

UATUAT – A pre-production environment that is used for user acceptance testing. The UAT environment is a

Tier-2 (Standard Acceptance Test) or higher environment. It runs the same version of Finance and

Operations apps as the production environment. It also runs the latest release version of your custom

code extensions. This environment is typically connected to a copy of the production database.

ProdProd – Your live production environment that runs on your production database.

The following environments run the next version of your custom code:

Dev 2Dev 2  – A development environment that is used for development of the next version of your custom code

extensions. It uses Azure DevOps for version control of custom code. It's connected to the development

branch (mainmain branch) of your custom code. For more information, see the Manage source code branches

section.

Test 2Test 2  – A functional test environment that is used for testing of the next version of your custom code

extensions.

It's important that you follow best practices as you manage branches of custom code. In this way, you help

minimize cost, and ensure the quality of your releases and updates.



  Apply the next version of a Microsoft service update

The mainmain branch (development branch) contains the latest functioning version of the next release of your code.

When you work on new features, create a new feature branch out of the mainmain branch. Then, when the feature

work is completed, integrate the feature branch back into the mainmain branch.

The release branches contain the code base of your official releases. In the preceding illustration, the assumption

is that you have only one release branch, release/2020-Aprilrelease/2020-April . 2020-April2020-April  isn't a build. It's a source code

branch. Because you will probably create hotfixes for your release, you will make changes and produce builds

out of this release branch.

Don't use release branches to develop new features. Use them only for critical fixes or changes that are

required in your live environment.

After you've made a change in a release branch, integrate the branch back into the mainmain branch. In this way,

you ensure that your next release also contains the fix.

Among the example environments that were described earlier, the Dev 1 environment will be connected to

the release/2020-Aprilrelease/2020-April  branch.

When you're ready to release a new version of your custom code, create a new release branch that is based on

the mainmain branch. For this example, you will create a new release branch that is based on mainmain and named

2020-July2020-July .

You might have private branches that individual developers work in while they work on a specific work item that

is based on a specific branch of your code. Private branches are merged back into their parent branch when the

work is completed. For more information, see Learn about branching strategies for Team Foundation Version

Control (TFVC) and how to select an effective strategy.

By using a phased approach, you help maximize the efficiency when service updates are taken. Each phase

updates one component of your implementation.

1. Phase 1Phase 1  – Update your Finance and Operations environments.

Your current version of Commerce Scale Unit (CSU) and Point of Sale (POS) will work correctly with the

new Finance and Operations update. For example, version 10.0.7 of CSU is compatible with version

10.0.11 of Finance and Operations apps.

2. Phase 2Phase 2  – Update CSU.

3. Phase 3Phase 3  – Update POS.

When you take a Microsoft update, you don't have to update your custom code to the next version. By taking

https://docs.microsoft.com/en-us/azure/devops/repos/tfvc/branching-strategies-with-tfvc


  

  

  

  

  

    

Backward compatibility of Microsoft updatesBackward compatibility of Microsoft updates

Runtime compatibilityRuntime compatibility

Design-time compatibilityDesign-time compatibility

Phase 1: Update the Finance and Operations implementationPhase 1: Update the Finance and Operations implementation

Track 1: Update your runtime environmentsTrack 1: Update your runtime environments

U p d a t e  Te s t  1U p d a t e  Te s t  1

Microsoft updates without bundling them with custom code updates, you help simplify the update process. You

also help reduce the cost and risk of regressions that are associated with all-in-one upgrade projects.

It's important that you understand what Microsoft means by backward compatibility of service updates, so that

you have context for the next sections of this topic. Service and quality updates are runtime backward-

compatible. However, they aren't always design-time (compile-time) backward-compatible.

All Microsoft updates are intended to be runtime backward-compatible. This compatibility covers both binary

compatibility and functional compatibility. Runtime compatibility means that customizations that exist in

production and sandbox environments will continue to work after Microsoft service updates are deployed to

those environments. Those updates include service updates and quality updates. Runtime compatibility also

means that Microsoft updates are backward-compatible with customizations that were compiled on an earlier

platform.

Binary compatibility is backward only. You can compile a customization on an older application version and

platform version, and deploy it to an environment that is running a later version. However, you can't deploy code

to an environment that is running a version that is earlier than the version that the code was compiled on.

Design-time (compile-time) backward compatibility means that developers can apply updates to their

development environments and successfully compile their code without having to make any changes.

Microsoft aims for design-time compatibility. However, some updates might include changes that aren't

compatible at design time, but that are binary-compatible. Therefore, after an update is applied, new errors or

warnings might occur when your code is compiled. Here are some examples of these changes:

Microsoft makes an enumeration extensible.

Microsoft marks an API as obsolete or internal.

Microsoft introduces a new compiler error to help prevent unsafe coding practices.

All these changes might require work on your solution. Design-time breaking changes that are binary-

compatible don't require a 12-month deprecation notice. These breaking changes are documented for each

service update. For more information, see What's new and changed in Platform updates.

This section summarizes the process that you use to update your Finance and Operations implementation to the

latest service update. An update from version 10.0.7 to version 10.0.11 is used as an example.

This phase is divided into two tracks. These tracks can occur in parallel.

Track 1Track 1  – Update your runtime environments.

Track 2Track 2  – Update your development environments.

After you complete track 1, you will be live on version 10.0.11, unless you encounter one of the error situations

that are described in the Error situations section.

By completing track 1, you essentially complete your Finance and Operations update to version 10.0.11, because

your production environment will be live on version 10.0.11. You don't have to recompile your custom code as

part of this track.

The Test 1 environment is running version 10.0.7 together with the latest released version of your custom

extension. Although an update of Test 1 isn't a prerequisite in this flow, it's recommended, because it adds

another level of functional verification and predictability. This update should be completed before the UAT

environment is updated. The sooner that you update Test 1 and validate on it, the more predictable your "real"

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/get-started/whats-new-home-page
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Track 2: Update your development environmentsTrack 2: Update your development environments

Error situationsError situations
C a se  1C a se  1

C a se  2C a se  2

update (that is, the update of the UAT and Prod environments) will be.

1. Apply version 10.0.11 of Finance and Operations apps to Test 1.

2. Sign off on functional scenarios. You can use the Regression Suite Automation Tool to automate user

acceptance testing on test and UAT environments.

3. If regressions are encountered, see the Error situations section.

The UAT environment is running version 10.0.7 together with a released version of your custom extension. (The

UAT environment is the same as the Prod environment.)

1. Apply version 10.0.11 of Finance and Operations apps to UAT.

Your UAT environment might be configured so that it's automatically updated by Microsoft. However, you

can always pull the update as soon as it's available.

2. Complete user acceptance testing, and sign off.

3. If regressions are encountered, see the Error situations section.

1. Apply version 10.0.11 of Finance and Operations apps to Prod.

Your Prod environment might be configured so that it's automatically updated by Microsoft. However,

you can always pull the update as soon as it's available.

2. Sign off.

The purpose of track 2 is to update the Dev 1 environment to version 10.0.11. Dev 1 is your mainmain development

environment that is connected to the current release branch of your custom code. It's running version 10.0.7 of

Finance and Operations apps. By completing track 2, you ensure that Dev 1 runs version 10.0.11 together with

your latest release, and that it's ready for any future hotfixes that are required for your code.

1. Apply version 10.0.11 of Finance and Operations apps to Dev 1.

2. Compile your custom code, and do testing.

3. Make any required changes to your custom code.

4. Check code changes in to the release branch.

5. If you have more than one development environment, follow these steps for each environment:

a. Apply version 10.0.11 of Finance and Operations apps to the development environment.

b. Sync and compile your latest custom code from the target code branch.

During track 1, a bug is found that requires a Microsoft quality update. If Microsoft releases the update in a

timely manner, use the new Microsoft update instead of the original service update to complete track 1.

During track 1, a bug is found that requires a Microsoft service update. However, the update can't be released in

a timely manner.

As a workaround for this issue, Microsoft proposes a change to your custom code.

1. Modify your code in Dev 1 (in the release branch), and test your updates.

2. Check code changes in to the release branch.

3. Create a new deployable package out of the release branch.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/perf-test/rsat/rsat-overview
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Phase 2: Update CSU to version 10.0.11Phase 2: Update CSU to version 10.0.11

Phase 2 prerequisitesPhase 2 prerequisites

Track 1: Update your CSU runtime environmentsTrack 1: Update your CSU runtime environments
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4. Apply the new deployable package to Test 1 and/or UAT.

Custom code that is compiled on version 10.0.7 can be deployed to any runtime environment that is running version

10.0.7 or later. Therefore, you don't yet have to update Dev 1 to version 10.0.11. However, you might already have done

that update as part of track 2.

During track 1, a bug is found that requires a change to your custom code. This bug might be in either your code

or the ISV code.

1. Modify your code in Dev 1 (in the release branch), and test your updates.

2. Check code changes in to the release branch.

3. Create a new deployable package out of the release branch.

4. Apply the new deployable package to Test 1 and/or UAT.

This section summarizes the process that you use to update your Commerce Scale Units to the latest service

update. An update from release 10.0.7 (Commerce version 9.17) to release 10.0.11 (Commerce version 9.21) is

used as an example.

Before you update your CSUs, you must update the Commerce headquarters environments (in the Finance and

Operations app) to the same release or a later release. For this example, that release is 10.0.11.

This phase is divided into two tracks. These tracks can occur in parallel.

Track 1Track 1  – Update your CSU runtime environments.

Track 2Track 2  – Update your development environments.

After you complete track 1, you will be live on release 10.0.11 (Commerce version 9.21), unless you encounter

one of the error situations that were described for phase 1.

By completing track 1, you essentially complete your CSU update to version 10.0.11, because your production

environment will be live on version 10.0.11. You don't have to recompile your custom code as part of this track.

The software as a service (SaaS) components of Commerce aren't currently supported in Tier-1 environments

(development/test environments). A copy of Retail Server runs locally in each Tier-1 environment, and the

deployment of both Microsoft code for Retail Server and retail customizations will be done through the previous

system, where application binary packages and retail deployable packages are applied against the infrastructure

as a service (IaaS) instance.

The UAT environment is running CSU that corresponds to release 10.0.7, together with the same version of your

retail extension that the production environment is running.

1. Update the Commerce Scale Unit. Select 9 .21 (10.0.11)9.21 (10.0.11)  as the target version. For more information, see

Phase 2: Update CSU to version 10.0.11

2. Complete user acceptance testing, and sign off.

3. If regressions are encountered, see the Error situations section.

1. Update the Commerce Scale Unit. Select 9 .21 (10.0.11)9.21 (10.0.11)  as the target version. For more information, see

Phase 2: Update CSU to version 10.0.11

2. Sign off.



        

  

  

  

  

Track 2: Update your development environmentsTrack 2: Update your development environments

Phase 3: Update POS to version 10.0.11Phase 3: Update POS to version 10.0.11

Phase 3 prerequisitesPhase 3 prerequisites

Update your Commerce development environmentUpdate your Commerce development environment

Option 1: Store component updates that include only runtime changesOption 1: Store component updates that include only runtime changes

1. Get the latest version of the Retail software development kit (SDK).

a. Apply the Finance and Operations service update for release 10.0.11 to Dev 1.

b. Get the updated version of the Retail SDK from %Ser viceDrive%\RetailSDK\Update\<newest%Ser viceDrive%\RetailSDK\Update\<newest

director y>director y>

2. In your mainmain (development) branch, update the Retail artifacts from the new version of the Retail SDK.

3. Compile. The new version should be backward-compatible and should not require any changes to your

code.

4. Commit the change that includes the Retail SDK update.

5. Make any required changes to your custom code.

6. Commit code changes to the target branch.

7. Optional: If you have more than one development environment, merge the latest changes from step 4,

and compile the latest custom code.

This section summarizes the process that you use to update your store components, such as Modern POS and

Hardware Station, to the latest service update. An update from release 10.0.7 (Commerce version 9.17) to

release 10.0.11 (Commerce version 9.21) is used as an example.

Unlike updates for Commerce headquarters (in the Finance and Operations app) and CSU, updates for store

components are delivered in the same packages. After you update Commerce headquarters and CSU, you have

the following options:

Option 0 (no operation is required)Option 0 (no operation is required)  – Leave the store components in their previous release if the version

is supported and in-policy.

Option 1Option 1  – Update the store components runtime (Microsoft code) so that it matches the same release as

CSU.

Option 2Option 2  – Update the store components runtime (Microsoft code) and customization together.

In the rest of this section, the assumption is that you want or have to update the store components (option 1 or

option 2).

After you complete this phase, you will be live on release 10.0.11 (Commerce version 9.21) for store

components, unless you encounter one of the error situations that are described for phase 1.

Phase 3 has the following prerequisites:

The Commerce headquarters components (in the Finance and Operations app) were updated to the same

release or a later release before the CSUs were updated. In this example, the version is 10.0.11.

The CSUs were updated to the same release as, or a later release than, the store components. In this example,

the release is 10.0.11.

Follow the steps in the Track 2: Update your development environments section.

This option generates a new retail deployable package that contains your store components. It includes changes

only from the Microsoft code.

1. Update your release branch, which has the code that is currently being used in the production environment,

to the Retail SDK that matches your target release. In this example, the version is 10.0.11 (9.21). Follow the



  

  

  

  

Option 2: Store component updates that include runtime and custom changesOption 2: Store component updates that include runtime and custom changes

Update processUpdate process
U p d a t e  Te s t  1U p d a t e  Te s t  1
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Apply a new version of your custom code

Create a hotfix of your codeCreate a hotfix of your code

steps in the Track 2: Update your development environments section.

2. Generate a new build for the retail deployable package. This build contains the same set of customizations

that is currently in the production environment, plus version 10.0.11 (9.21) of the Microsoft code.

This option generates a new retail deployable package that contains your store components. It includes changes

from both the Microsoft code and customizations.

1. Update your release branch, which has the code that is currently being used in the production environment,

to the Retail SDK that matches your target release. In this example, the version is 10.0.11 (9.21). Follow the

steps in the Track 2: Update your development environments section.

2. Commit changes.

3. Update custom code for store components, or update references to ISV-updated components.

4. Generate a new build for the retail deployable package. This build contains updated custom code plus

version 10.0.11 (9.21) of the Microsoft code.

The SaaS components of Commerce aren't currently supported in development or test one-box environments. A

copy of Retail Server runs locally in each development or test one-box environment, and the deployment of

both Microsoft code for Retail Server and retail customizations will be done through the previous system, where

application binary packages and retail deployable packages are applied against the IaaS instance.

The Test 1 environment is running version 10.0.11 of Commerce headquarters and a local version of CSU from

previous phases. An update of Test 1 isn't a prerequisite in this flow. Because there is no CSU in this

environment, this step is mostly for verification.

1. Upload, update, and deploy the store components. For more information, see the Upload, update, and deploy

store components section.

2. Sign off on functional scenarios.

3. If regressions are encountered, see the Error situations section.

Clients that point to the UAT environment are running applications (for example, Modern POS) for release 10.0.7

(the same version that is currently running in the production environment).

1. Upload, update, and deploy the store components. For more information, see the Upload, update, and deploy

store components section.

2. Sign off on functional scenarios.

3. If regressions are encountered, see the Error situations section.

1. Upload, update, and deploy the store components.

2. Sign off.

This section describes the recommended flow for two use cases that require that you update your UAT and/or

Prod environment with a new build of your custom extension.

When a critical bug is found in the UAT or Prod environment, fix the bug in the release branch (not in the mainmain

or development branch), and use the standard process to apply a deployable package to UAT and Prod.



  

   

Update your custom code from release N to release N+1Update your custom code from release N to release N+1

Upload, update, and deploy store components

1. In Dev 1, make the code fix in the release branch. If the required fix is in ISV code, ask the ISV to send you a

new build of the current release, not the next version of the solution.

2. Compile and test.

3. Create a new deployable package out of the release branch.

4. Deploy on Test 1, and sign off if sign-off is required.

5. Use the standard process to deploy custom code first to UAT and then to Prod.

6. Integrate the code fix with your mainmain code branch.

When you're ready to release the next version of your custom code, use the following process to create and

deploy the new release.

1. In the Dev 2 environment, or another environment that is connected to the mainmain branch, complete

development in the mainmain branch.

2. Deploy and test on Test 2.

3. Repeat steps 1 through 2 until the new version is signed-off on.

4. Create a newnew  release branch.

5. Create a new deployable package out of the newnew  release branch.

6. Use the standard process to deploy custom code first to UAT and then to Prod.

7. Retire the old release branch.

1. Upload the retail deployable package to LCS.

2. Update Application Object Server (AOS) with the latest client.

3. Upload the retail deployable package to your Asset library:

Older deployments (ear lier  than version 10.0.11):Older deployments (ear lier  than version 10.0.11): Software deployable package

New deployments (version 10.0.11 and later):New deployments (version 10.0.11 and later): Retail self-service installers



NOTENOTE

4. Update Commerce headquarters with the new self-service installers for store components:

Older deployments (ear lier  than version 10.0.11):Older deployments (ear lier  than version 10.0.11): Deploy the retail deployable package to

Commerce headquarters via LCS.

New deployments (version 10.0.11 and later):New deployments (version 10.0.11 and later): In Commerce headquarters, on the CommerceCommerce

parametersparameters  form, on the Channel deploymentChannel deployment tab, select Check for package updatesCheck for package updates . This

update will bring in the packages that are available on the Retail Self-ser vice packageRetail Self-ser vice package tab in the

LCS Asset library.

5. Assign the client versions to your devices.

6. Download the installers for the desired client type and device.

7. Install in target device.

8. Test and validate.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Modern Lifecycle Policy

This topic outlines the lifecycle and support policies for the Finance and Operations online service.

The Finance and Operations online service is covered by the Modern Lifecycle Policy. The Modern Lifecycle

Policy covers products and services that are serviced and supported continuously. For more information about

this policy, see Modern Lifecycle Policy. Licensed customers must stay current with updates to the Finance and

Operations online service in accordance with the following servicing and system requirements:

Customers purchasing subscriptions of Finance and Operations and operating on the following

application versions will experience continuous updates of the Platform and Financial Reporting.

Microsoft will continually update these components with the option to postpone up to 3 consecutive

service updates.

Dynamics 365 for Operations version 1611 (November 2016)

Dynamics 365 for Finance and Operations, Enterprise edition (July 2017)

Dynamics 365 for Finance and Operations, Enterprise edition 7.3

Dynamics 365 for Finance and Operations, version 8.0 (April 2018)

Platform versions maintain backward compatibility with the application versions that are supported at

the time of the platform release within the application support lifecycle. For more information about

platform versions, see Cloud platform monthly updates FAQ.

Critical fixes and non-critical updates are handled in the following way:

Cr itical fixesCritical fixes  – Critical fixes include security fixes and any fixes that are required to adhere to the

availability service level agreement (SLA) that the service supports. Critical fixes will be made

available in the latest platform update version and in the latest service update for customers

operating on version 8.1. In addition, to help protect the customer and the online service,

Microsoft might apply critical fixes directly to a customer's environment. If a critical fix must be

applied, Microsoft will notify the customer about the required downtime window (if there will be

any downtime) and apply the fix to the applicable environment. The critical fix will update the

system to the latest update version.

Non-cr itical updatesNon-cr itical updates  – Customers operating on the following application releases must update

to the most current Finance and Operations platform and financial reporter version to deploy non-

critical updates.

Dynamics 365 for Operations version 1611 (November 2016)

Dynamics 365 for Finance and Operations, Enterprise edition (July 2017)

Dynamics 365 for Finance and Operations, Enterprise edition 7.3

Dynamics 365 for Finance and Operations, version 8.0 (April 2018)

Customers operating on release 8.1 must update to the most current service update to deploy

non-critical updates.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/migration-upgrade/versions-update-policy.md
https://support.microsoft.com/help/30881
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/sysadmin/faq-platform-monthly-updates
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Dates and versions for application and platform releases
Table 1: Continuous update releasesTable 1: Continuous update releases

REL EA SEREL EA SE

M A JO R REL EA SEM A JO R REL EA SE
O R SERVIC EO R SERVIC E
UP DAT EUP DAT E VERSIO NVERSIO N B UIL D N UM B ERB UIL D N UM B ER AVA IL A B IL IT YAVA IL A B IL IT Y EN D O F  SERVIC EEN D O F  SERVIC E

Dynamics 365
for Finance and
Operations

Major release 10.0 10.0.8 April 2019 Not applicable
(continuously
updated)*

Dynamics 365
for Finance and
Operations

Major release 8.1 8.1.136 October 2018 Not applicable
(continuously
updated)*

Table 2: Application releasesTable 2: Application releases

REL EA SEREL EA SE
M A JO R O RM A JO R O R
M IN O R REL EA SEM IN O R REL EA SE VERSIO NVERSIO N B UIL D N UM B ERB UIL D N UM B ER AVA IL A B IL IT YAVA IL A B IL IT Y EN D O F  SERVIC EEN D O F  SERVIC E

Dynamics 365
for Finance and
Operations

Major release 8.0 8.0.30 April 2018 April 30 2019

Dynamics 365
for Finance and
Operations,
Enterprise
edition

Major release 7.3 7.3.11971.56116 December 2017 April 30 2019*

Dynamics 365
for Finance and
Operations,
Enterprise
edition

Major release July 2017 7.2.11792.56024 June 2017 April 30 2019

Application and platform releases expire at the end of the month of their software lifecycle.

Microsoft will not provide any fixes to issues on versions that have reached end of service. Microsoft will also not

investigate or troubleshoot any issue that you may encounter on an older version. If you encounter an issue on a version

that has reached end of service, you will be required to update to the latest update and report the issue if it persists.

All environments will continue to be operated by Microsoft. All automatic processes around your environments, such as

monitoring or self-healing, will also continue as is for supported versions.

For information about the new features included in each release, click the links in the VersionVersion column.

* Indicates a major release is required to be updated through service updates. Service updates are cumulative in

nature and may include updates for some or all of the following components: Platform, Application, Financial

Reporting, Retail, and operating system updates. You will be required to have an update that's no older than 3

service updates. The 8.1.x version series will be replaced by version 10.0, which is targeted for release in April

2019. For more information, see One Version service updates FAQ.

For information about the new features included in each release, select the links in the VersionVersion column.

https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-changed-10
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-changed-8-1-october-2018
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-changed-8-0-april-2018
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-application-7.3-update
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-application-july-2017-update


Dynamics 365
for Operations

Major release 1611 7.1.1541.3036 November 2016 April 30 2019

Dynamics AX Minor release 7.0.1 7.0.1265.23014 May 2016 June 2017

Dynamics AX Major release 7.0 7.0.1265.3015 February 2016 June 2017

REL EA SEREL EA SE
M A JO R O RM A JO R O R
M IN O R REL EA SEM IN O R REL EA SE VERSIO NVERSIO N B UIL D N UM B ERB UIL D N UM B ER AVA IL A B IL IT YAVA IL A B IL IT Y EN D O F  SERVIC EEN D O F  SERVIC E

Table 3: Platform releasesTable 3: Platform releases

REL EA SEREL EA SE B UIL D N UM B ERB UIL D N UM B ER AVA IL A B IL IT YAVA IL A B IL IT Y EXP IRAT IO N  DAT EEXP IRAT IO N  DAT E

Platform update 31 7.0.5457 January 2020 N/A (Continuously updated)

Platform update 30 7.0.5407 November 2019 N/A (Continuously updated)

Platform update 29 7.0.5372 October 2019 N/A (Continuously updated)

Platform update 28 7.0.5314 July 2019 N/A (Continuously updated)

Platform update 27 7.0.5286 June 2019 N/A (Continuously updated)

Platform update 26 7.0.5257 May 2019 N/A (Continuously updated)

Platform update 25 7.0.5222 April 2019 N/A (Continuously updated)

Platform update 24 7.0.5179 March 2019 N/A (Continuously updated)

Platform update 23 7.0.5126 January 2019 N/A (Continuously updated)

Platform update 22 7.0.5095 December 2018 N/A (Continuously updated
/ Retired)

Platform update 21 7.0.5073 October 2018 N/A (Continuously updated
/ Retired)

Platform update 20** 7.0.5030 October 2018 N/A (Continuously updated
/ Retired)

Platform update 15* 7.0.4841 March 2018 N/A (Continuously updated
/ Retired)

Platform update 12 7.0.4709 November 2017 November 2018

Platform update 11 7.0.4679.35176 October 2017 October 2018

* All customers must be on the latest version of Finance and Operations by April 2019. However, we are making

an exception for customers who have unfulfilled extension requests that have been submitted to Microsoft.

Those customers who submitted extensibility requests by January 1, 2019, will be supported on version 7.3 until

their extensibility requests are fulfilled. Customers are expected to upgrade to the latest version within 90 days

of the extensibility request being fulfilled. For more information, see One Version service updates FAQ.

For information about the new features included in each release, select the links in the ReleaseRelease column.

https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-dynamics-365-operations-1611
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-changed-application-version-7-0-1-may-2016
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-changed-7-0-february-2016
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/extensibility/extensibility-home-page
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/get-started/whats-new-platform-update-31
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-30
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-29
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-28
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-27
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-26
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-25
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-24
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-23
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-22
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-21
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-20
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-15
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-12
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-11


Platform update 10 7.0.4641.16233 August 2017 August 2018

Platform update 9 7.0.4612.35162 July 2017 July 2018

Platform update 8 7.0.4565.16212 June 2017 June 2018

Platform update 7 7.0.4542.16189 May 2017 May 2018

Platform update 6 7.0.4509.16180 April 2017 April 2018

Platform update 5 7.0.4475.16165 March 2017 March 2018

Platform update 4 7.0.4425.16161 February 2017 February 2018

Platform update 3 7.0.4307.16141 November 2016 November 2017

Platform update 2 7.0.4230.16130 August 2016 August 2017

Platform update 1 7.0.4127.16103 May 2016 May 2017

Platform 7.0 7.0.4030.16079 February 2016 January 2017

REL EA SEREL EA SE B UIL D N UM B ERB UIL D N UM B ER AVA IL A B IL IT YAVA IL A B IL IT Y EXP IRAT IO N  DAT EEXP IRAT IO N  DAT E

Table 4: Application updatesTable 4: Application updates

REL EA SEREL EA SE VERSIO NVERSIO N B UIL D N UM B ERB UIL D N UM B ER AVA IL A B IL IT YAVA IL A B IL IT Y

Dynamics 365 for Finance
and Operations

8.1.3: KB 4470000
Microsoft Dynamics 365 for
Finance and Operations
version 8.1.3 with Platform
update 23*

8.1.227 January 2019

Dynamics 365 for Finance
and Operations

8.1.2: KB 4470000
Microsoft Dynamics 365 for
Finance and Operations
version 8.1.2 with Platform
update 22*

8.1.195 December 2018

** Platform updates 16, 17, 18, and 19 have not been made generally available.

* Platform updates 13 and 14 have not been made generally available.

The application updates listed below consist of a small subset of application enhancements released on top of

Finance and Operations versions 8.0, 7.3, and 7.2 (July 2017). These updates do not affect the support lifecycle

of the release--support is in-line with the policies for each release.

Note that application updates are not cumulative. The individual packages only contain the enhancements that

were included in that specific release. However, if there is a dependency between two packages, then both

packages will be included.

For information about the new features included in each update, click the links in the VersionVersion column.

https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-10
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-9
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-8
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-7
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-6
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-5
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-4
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-3
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-platform-update-2
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-changed-platform-version-7-1-may-2016
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/whats-new-changed-7-0-february-2016
https://go.microsoft.com/fwlink/?linkid=2049362
https://go.microsoft.com/fwlink/?linkid=2049368


Dynamics 365 for Finance
and Operations

8.1.1: KB 4470000
Microsoft Dynamics 365 for
Finance and Operations
version 8.1.1 with Platform
update 21*

8.1.170 October 2018

Dynamics 365 for Finance
and Operations

8.0.4: KB 4458992
Microsoft Dynamics 365 for
Finance and Operations -
Version 8.0.4 (Binary part)*,
KB 4458993 Microsoft
Dynamics 365 for Finance
and Operations - Version
8.0.4 (X++ part)*

8.0.35.15532 August 2018

Dynamics 365 for Finance
and Operations

8.0.3: KB 4346176
Microsoft Dynamics 365 for
Finance and Operations -
Version 8.0.3 (Binary part)*,
KB 4346172 Microsoft
Dynamics 365 for Finance
and Operations - Version
8.0.3 (X++ part)*

8.0.35.15342 July 2018

Dynamics 365 for Finance
and Operations

8.0.2: KB 4340414
Microsoft Dynamics 365 for
Finance and Operations -
Version 8.0.2 (Binary part)*,
KB 4340413 Microsoft
Dynamics 365 for Finance
and Operations - Version
8.0.2 (X++ part)*

8.0.35.15211 July 2018

Dynamics 365 for Finance
and Operations

8.0.1: KB 4295107
Microsoft Dynamics 365 for
Finance and Operations -
Version 8.0.1 (Binary part)*,
KB 4294515 Microsoft
Dynamics 365 for Finance
and Operations - Version
8.0.1 (X++ part)*

8.0.30.15107 June 2018

Dynamics 365 for Finance
and Operations, Enterprise
edition

7.3.2: KB 4093261
Microsoft Dynamics 365 for
Finance and Operations -
Version 7.3.2 (Binary part)*,
KB 4093262 Microsoft
Dynamics 365 for Finance
and Operations - Version
7.3.2 (X++ part)*

7.3.11971.62687 March 2018

Dynamics 365 for Finance
and Operations, Enterprise
edition

7.3.1: KB 4093139
Microsoft Dynamics 365 for
Finance and Operations -
Version 7.3.1 (Binary part)*,
KB 4091727 Microsoft
Dynamics 365 for Finance
and Operations - Version
7.3.1 (X++ part)*

7.3.11971.62430 March 2018

REL EA SEREL EA SE VERSIO NVERSIO N B UIL D N UM B ERB UIL D N UM B ER AVA IL A B IL IT YAVA IL A B IL IT Y

https://go.microsoft.com/fwlink/?linkid=2038101
https://fix.lcs.dynamics.com/Issue/Details?kb=4458992&bugId=239612&qc=70318005e232acfe98df16bf3ab4cdf8df463634e28ff3ce2ef1db29c8678863
https://fix.lcs.dynamics.com/Issue/Details?kb=4458993&bugId=239610&qc=70318005e232acfe98df16bf3ab4cdf8df463634e28ff3ce2ef1db29c8678863
https://fix.lcs.dynamics.com/Issue/Details?kb=4346176&bugId=230723&qc=15b7470493e66efed8446f7ad2269bde9804da7174d135900c99b7318bb26e34
https://fix.lcs.dynamics.com/Issue/Details?kb=4346172&bugId=230724&qc=15b7470493e66efed8446f7ad2269bde9804da7174d135900c99b7318bb26e34
https://fix.lcs.dynamics.com/Issue/Details?kb=4340414&bugId=219341&qc=0d87f4d28eb75753e9c4ceeb997ab6bf2a0ff5d0b58342ecd9512cc721e0cc80
https://fix.lcs.dynamics.com/Issue/Details?kb=4340413&bugId=219344&qc=0d95ca5957e7b1288e6d56bcf3bc6c014baf9e916d976fd100ae24db3d2b1a14
https://fix.lcs.dynamics.com/Issue/Details?kb=4295107&bugId=192587&qc=70f6f8fbdd96b01197fedc9442b5c43c2e01e2748eb0d5a20d87bceb4c0b939d
https://fix.lcs.dynamics.com/Issue/Details?kb=4294515&bugId=194698&qc=70f6f8fbdd96b01197fedc9442b5c43c2e01e2748eb0d5a20d87bceb4c0b939d
https://fix.lcs.dynamics.com/Issue/Details?kb=4093261&bugId=3937217&qc=848a3e7a82137b3ac4412537f1fdb4fafacab7d7565e0a7a6930b0c96406c96a
https://fix.lcs.dynamics.com/Issue/Details?kb=4093262&bugId=3937219&qc=848a3e7a82137b3ac4412537f1fdb4fafacab7d7565e0a7a6930b0c96406c96a
https://fix.lcs.dynamics.com/Issue/Details?bugId=3933782&qc=419638525c20d4bcd818cd40be05a12876e4c00a39124d2e44a0d950af21be89
https://fix.lcs.dynamics.com/Issue/Details?bugId=3933783&qc=419638525c20d4bcd818cd40be05a12876e4c00a39124d2e44a0d950af21be89


Dynamics 365 for Finance
and Operations, Enterprise
edition

Application update 5: KB
4053277 Application
Update 5 for Microsoft
Dynamics 365 for Finance
and Operations (Binary
part)*, KB 4053278
Application Update 5 for
Microsoft Dynamics 365 for
Finance and Operations
(X++ part)*

7.2.11792.62725 November 2017

Dynamics 365 for Finance
and Operations, Enterprise
edition

Application update 4: KB
4047325 Application
Update 4 for Dynamics 365
for Finance and Operations
(Binary part)*, KB 4047321
Application Update 4 for
Dynamics 365 for Finance
and Operations (X++ part)*

7.2.11792.62509 October 2017

Dynamics 365 for Finance
and Operations, Enterprise
edition

Application update 3: KB
4043284 Application
Update 3 for Dynamics 365
for Finance and Operations
(Binary part)*, KB 4043285
Application Update 3 for
Dynamics 365 for Finance
and Operations (X++ part)*

7.2.11792.62370 September 2017

Dynamics 365 for Finance
and Operations, Enterprise
edition

Application update 2: KB
4039142 Application
Update 2 for Dynamics 365
for Finance and Operations
(Binary part)*, KB 4039487
Application Update 2 for
Dynamics 365 for Finance
and Operations (X++ part)*

7.2.11792.62192 September 2017

Dynamics 365 for Finance
and Operations, Enterprise
edition

Application update 1: KB
4035749 Application
Update 1 for Dynamics 365
for Finance and Operations
(Binary part)*, KB 4035751
Application Update 1 for
Dynamics 365 for Finance
and Operations (X++ part)*

7.2.11792.62089 July 2017

REL EA SEREL EA SE VERSIO NVERSIO N B UIL D N UM B ERB UIL D N UM B ER AVA IL A B IL IT YAVA IL A B IL IT Y

Support matrix

Table 5: Downloadable virtual hard drive (VHD) releasesTable 5: Downloadable virtual hard drive (VHD) releases

* The link points to a Knowledge Base (KB) article. You must sign in to Lifecycle Services (LCS) to view the KB

article.

Platform updates are compatible with all application versions that are supported at the time of release.

Use of the VHDs is subject to the Software license terms.

https://fix.lcs.dynamics.com/Issue/Resolved?kb=4053277&bugId=3893141&qc=ee9db96dd13dc341e7019fad3d36d01c6dfc4edf631f752f66d87f2ebbd256f5
https://fix.lcs.dynamics.com/Issue/Resolved?kb=4053278&bugId=3893143&qc=ee9db96dd13dc341e7019fad3d36d01c6dfc4edf631f752f66d87f2ebbd256f5
https://fix.lcs.dynamics.com/Issue/Resolved?kb=4047325&bugId=3866272&qc=dfcd40f8c5d0d863cc6ae10fe7dd3fb57450327d4f82f10c57886d579e6d4838
https://fix.lcs.dynamics.com/Issue/Resolved?kb=4047321&bugId=3866273&qc=dfcd40f8c5d0d863cc6ae10fe7dd3fb57450327d4f82f10c57886d579e6d4838
https://fix.lcs.dynamics.com/Issue/Resolved?kb=4043284&bugId=3857197&qc=e6921e68e9b9037bf91c26b3b553e479890731b4b4dd5e6dcb45b0ca13895d8d
https://fix.lcs.dynamics.com/Issue/Resolved?kb=4043285&bugId=3857199&qc=54ee2e988aace65d26834ced54cc11326f5d5e435520ccaf951d41bd1276f672
https://fix.lcs.dynamics.com/Issue/Resolved?kb=4039142&bugId=3850590&qc=5339dbbd18aacbc8bdcbe4123d749d28803653d6c68f787bd8fc3337e97693df
https://fix.lcs.dynamics.com/Issue/Resolved?kb=4039487&bugId=3850591&qc=5339dbbd18aacbc8bdcbe4123d749d28803653d6c68f787bd8fc3337e97693df
https://fix.lcs.dynamics.com/Issue/Resolved?kb=4035749&bugId=3845890&qc=5339dbbd18aacbc8bdcbe4123d749d28803653d6c68f787bd8fc3337e97693df
https://fix.lcs.dynamics.com/Issue/Resolved?kb=4035751&bugId=3845891&qc=5339dbbd18aacbc8bdcbe4123d749d28803653d6c68f787bd8fc3337e97693df
https://go.microsoft.com/fwlink/?linkid=851163


REL EA SEREL EA SE VH D N A M EVH D N A M E VH D EXP IRAT IO N  DAT EVH D EXP IRAT IO N  DAT E

Platform update 12 / Application
release 7.2

FinandOps7.2PlatUpdate12.vhd May 24, 2018

Platform update 12 / Application
release 7.3

FinandOps7.3PlatUpdate12.vhd June 05, 2018

Platform update 15 / Application
release 7.3

FinandOps7.3withPlatUpdate15 December 08, 2018

NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Modern Lifecycle Policy

On-premises software update policies

Finance + Operations (on-premises) release dates
Continuous service updatesContinuous service updates

Application releasesApplication releases
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EXP IRAT IO NEXP IRAT IO N
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Continuous
service updates

- - - - -

This topic outlines the lifecycle and support policies for Microsoft Dynamics 365 Finance + Operations (on-

premises) releases.

Finance + Operations (on-premises) software is covered by the Modern Lifecycle Policy. The Modern Lifecycle

Policy covers products and services that are serviced and supported continuously. For more information about

this policy, see Modern Lifecycle Policy.

Licensed customers must stay current with updates to the Finance + Operations (on-premises) software in

accordance with the following servicing and system requirements. This policy requires that the customer

maintain Software Assurance (SA) or the Enhancement Plan, and deploy updates as noted later in this topic.

Customers who want to use the Fixed Support Lifecycle Policy (5+5) must downgrade to Microsoft Dynamics AX

2012 R3. If a customer lapses on SA or the Enhancement Plan, the customer will be eligible only for the

perpetual license rights to Microsoft Dynamics AX 2012 R3 and must uninstall Microsoft Dynamics 365 for

Finance and Operations (on-premises) software.

The customer is in full control of its on-premises deployments and must follow this policy. The customer is in

control of installing updates in its on-premises environments. Microsoft will support the Finance + Operations

(on-premises) software through December 31, 2027, at a minimum, but only if the customer keeps the deployed

software current according to this policy.

Critical fixes and non-critical updates are handled in the following way:

Cr itical fixesCritical fixes  – Critical fixes include security fixes and any fixes that are required to support reliability and

availability. Critical fixes will be made available in the latest platform update version.

Non-cr itical updatesNon-cr itical updates  – Customers must update to the most current Finance and Operations platform and

financial reporter version to deploy non-critical updates.

As of November 2018, on-premises service updates are released continuously. For more information about

version numbers and availability dates, see Software lifecycle policy and cloud releases. For more information

about One Version service updates, see One Version service updates FAQ.

Application releases expire at the end of the month of their software lifecycle.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/migration-upgrade/on-prem-version-update-policy.md
https://support.microsoft.com/help/30881/modern-lifecycle-policy


Dynamics 365
for Finance and
Operations (on-
premises)

10.0 10.0.8 March 2019 June 2019 December 2027

Dynamics 365
for Finance and
Operations (on-
premises)

8.1 8.1.136 November 2018 April 2019 December 2027

Dynamics 365
for Finance and
Operations,
Enterprise
edition (on-
premises)

7.3 7.3.11971 March 2018 April 2020* December 2027

Dynamics 365
for Finance and
Operations,
Enterprise
edition (on-
premises)

July 2017 7.2.11792 June 2017 April 2019 December 2027

REL EA SEREL EA SE VERSIO NVERSIO N B UIL D N UM B ERB UIL D N UM B ER AVA IL A B IL IT YAVA IL A B IL IT Y
EXP IRAT IO NEXP IRAT IO N
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Platform releasesPlatform releases

REL EA SEREL EA SE B UIL D N UM B ERB UIL D N UM B ER AVA IL A B IL IT YAVA IL A B IL IT Y EXP IRAT IO NEXP IRAT IO N EN D O F  L IF EEN D O F  L IF E

Continuous service
updates

- - - -

Platform update 20 7.0.5030 November 2018 February 2019 December 2027

Platform update 15 7.0.4841 June 2018 September 2018 December 2027

Platform update 12 7.0.4709.41182 March 2018 June 2018 December 2027

Platform update 11 7.0.4679.35176 October 2017 April 2018 December 2027

Platform update 10 7.0.4641.16233 August 2017 April 2018 December 2027

Platform update 9 7.0.4612.35162 August 2017 April 2018 December 2027

Platform update 8 7.0.4565.1612 July 2017 April 2018 December 2027

* All customers must be on the latest version of Finance and Operations by April 30, 2019. However, we are

making an exception for customers who have unfulfilled extension requests that have been submitted to

Microsoft. Those customers can be on version 7.3 until April 2020. For more information, see One Version

service updates FAQ.

Platform releases expire at the end of the month of their software lifecycle.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/extensibility/extensibility-home-page


NOTENOTE

Downloadable virtual hard drive (VHD) releasesDownloadable virtual hard drive (VHD) releases

REL EA SEREL EA SE VH D N A M EVH D N A M E VH D EXP IRAT IO N  DAT EVH D EXP IRAT IO N  DAT E

Platform update 12 / Application
release 7.2

FinandOps7.2PlatUpdate12.vhd May 24, 2018

Platform update 12 / Application
release 7.3

FinandOps7.3PlatUpdate12.vhd June 05, 2018

Platform update 15 / Application
release 7.3

FinandOps7.3withPlatUpdate15 December 08, 2018

NOTENOTE

Platform releases are cumulative in nature. Any fixes, critical or non-critical, will require customers to take the latest

available version of the platform.

Use of the VHDs is subject to the Software license terms.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://go.microsoft.com/fwlink/?linkid=851163
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

Targeted release schedule (dates subject to change)Targeted release schedule (dates subject to change)

NOTENOTE

VERSIO NVERSIO N
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10.0.20 May 28, 2021 July 16, 2021 July 30, 2021 October 22, 2021

10.0.19 April 23, 2021 June 18, 2021 July 2, 2021 September 17, 2021

10.0.18 March 5, 2021 April 16, 2021 April 30, 2021 July 16, 2021

10.0.17 February 1, 2021 March 19, 2021 April 2, 2021 June 11, 2021

10.0.16 November 20, 2020 January 22, 2021 February 1, 2021 April 30, 2021

10.0.15 October 9, 2020 December 4, 2020 January 1, 2021 March 19, 2021

10.0.14 September 4, 2020 October 23, 2020 November 1, 2020 January 22, 2021

10.0.13 August 3, 2020 September 18, 2020 October 1, 2020 December 4, 2020

10.0.12 May 29, 2020 July 22, 2020 August 1, 2020 October 23, 2020

10.0.11 April 17, 2020 May 29, 2020 July 1, 2020 September 11, 2020

Microsoft is committed to delivering predictable service updates. These service updates will be made generally

available for self-deployment approximately 2 weeks prior to Microsoft automatically applying the update.

Customers will be able to take up to 8 service updates per year and are required to take a minimum of 2 service

updates per year. Customers can choose to pause up to 3 consecutive updates at a time. Pausing a service

update can apply to the designated user acceptance testing (UAT) sandbox, production, or both environments.

After the pause window has ended and if the customer has not self-updated to a supported service update,

Microsoft will auto-apply the latest update based on the configuration selection made available in Lifecycle

Services (LCS). To learn more about how to pause service updates, see Pause service updates through Lifecycle

Services.

Service updates will not be provided during the months of March, June, September, and December.

Sandbox auto-update takes place 7 days prior to the production update. End of service indicates the date when no new

cumulative service updates will be provided.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/public-preview-releases.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/lifecycle-services/pause-service-updates


10.0.10 March 6, 2020 April 10, 2020 May 1, 2020 July 3, 2020

10.0.9/Platform
update 33

February 1, 2020 March 13, 2020 April 1, 2020 June 5, 2020

10.0.8/Platform
update 32

November 29, 2019 January 17, 2020 February 1, 2020 May 1, 2020

10.0.7/Platform
update 31

October 25, 2019 November 29, 2019 January 1, 2020 March 9, 2020

10.0.6/Platform
update 30

September 6, 2019 October 11, 2019 November 1, 2019 January 13, 2020

10.0.5/Platform
update 29

August 2, 2019 September 13, 2019 October 1, 2019 December 2, 2019

10.0.4/Platform
update 28

June 7, 2019 July 12, 2019 August 1, 2019 October 14, 2019

10.0.3/Platform
update 27

May 10, 2019 June 14, 2019 July 1, 2019 September 9, 2019

10.0.2/Platform
update 26

April 12, 2019 May 17, 2019 June 1, 2019 August 12, 2019

10.0.1/Platform
update 25

May 1, 2019 June 10, 2019
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NOTENOTE

Service update overview

The Software lifecycle policy applies to customers enrolled in First Release and when the service update is made generally

available.

Sign up for the PEAP program by joining the Insider Program available at https://experience.dynamics.com.

After your nomination has been accepted, join the program.

Public previews are made available as a deployable package via the Shared Asset Library in Lifecycle Services.

For more details, see One Version service updates FAQ.

Service updates are continuous, touchless updates that provide new features and functionality. They eliminate

the need to do expensive upgrades every few years. The service updates maintain backward compatibility, which

means there is no need to ‘merge your code’. We recommend leveraging tools such as the Regression suite

automation tool (RSAT) for regression testing.

You are in control and manage how your organization receives these updates. For example, you can sign up for

the First Release program so that your organization receives updates first. You can apply the updates to any of

https://experience.dynamics.com


Release processes

NOTENOTE

your environments manually (self-update) or remain on the default release schedule and receive the auto-

updates when you schedule them using LCS.

Service updates contain both application and platform changes that are critical improvements to the service,

including regulatory updates.

Each new release is designed and developed by the Dynamics 365 team. Any new release is first validated by the

feature team, then by the Finance and Operations teams. During this time, extensive testing is done on various

test topologies. A compatibility checker also runs tests to ensure backward compatibility. In addition, a Release

Validation Program is available for customers to join. This program allows customers to share artifacts, such as

databases and code, that is used for benchmarking and tested with automation to provide an additional layer of

quality assurance.

Preview Early Access Program (PEAP) is available to partners, customers, and ISV’s who opt in through the PEAP

Survey. As a participant in the PEAP program you will have first access and visibility into the preview for the

upcoming service update. The preview service update is used to validate customizations, learn about new

features, and provide feedback to Microsoft. During this phase, the service update must be deployed on a

Dev/Test environment. This release cannot be used in production. To join the PEAP program, sign up via the

PEAP Survey.

The First Release program is open to all customers. Customers who join the First Release program will be the

first, select group of customers to take the service update all the way to production. Microsoft will manage the

deployment of this service update to a UAT sandbox and then 7 days later will auto-deploy the update to

production. Customers participating in this program have the additional benefit of having dedicated Microsoft

engineers closely monitoring the environments for any issues after updates have been applied. To join First

Release, sign up via the First Release Survey.

The service update will be made generally available using the action center in LCS. When the service update is

available, it can be manually applied to all environments including production. If the service update has not been

applied to the designated sandbox or production environment, Microsoft will auto-apply the update based on

the Update settings for the LCS project. To learn more, see Configure service updates through Lifecycle Services.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://forms.office.com/Pages/ResponsePage.aspx?id=v4j5cvGGr0GRqy180BHbR56j8lZs0FdAvwT75_WNFyxUQVdKVkVORjVDNloxTEkwS1JUSUxWN1pSWi4u
https://aka.ms/PEAP
https://aka.ms/PEAP
https://aka.ms/FirstRelease
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/lifecycle-services/configure-service-updates
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

Supported environments

NOTENOTE

Key concepts

Supported package types

This topic describes how you can use Microsoft Dynamics Lifecycle Services (LCS) to automatically apply

updates to cloud environments.

Updates are applied using deployable packages. Applying updates causes system downtime. All relevant services will be

stopped, and you won't be able to use your environments while the package is being applied. You should plan accordingly.

All environments deployed through Lifecycle Services are supported.

If you have a build environment, you can only use LCS to apply Binary updates and Data upgrade packages. You can't use

LCS to apply an Application Deployable package.

For other environments (listed below), you must use Remote Desktop Protocol (RDP) to connect to the

environment and install from the command line. For information about manual package deployment, see Install

deployable packages from the command line.

Local development environments (Downloadable virtual hard disk [VHD])

Multi-box dev/test environments in Microsoft Azure (Partner and trial projects)

Before you begin, you should understand deployable packages, runbooks, and the AXInstaller. A deployable

package is a unit of deployment that can be applied in any environment. A deployable package can be a binary

update to the platform or other runtime components, an updated application (AOT) package, or a new

application (AOT) package. The AXInstaller creates a runbook that enables installing a package. For more details,

see Packages, runbooks, and the AXUpdateInstaller in depth at the end of this topic.

AOT deployable packageAOT deployable package – A deployable package that is generated from application metadata and source

code. This deployable package is created in a development or build environment.

Application and Platform Binar y update packageApplication and Platform Binar y update package – A deployable package that contains dynamic-link

libraries (DLLs) and other binaries and metadata that the platform and application depend on. This is a

package released by Microsoft. This is available from the All binar y updatesAll binar y updates  tile from LCS.

Platform update packagePlatform update package – A deployable package that contains dynamic-link libraries (DLLs) and other

binaries and metadata that the platform depend on. This is a package released by Microsoft. This is available

from the Platform binar y updatesPlatform binar y updates  tile from LCS.

Commerce deployable packageCommerce deployable package – A combination of various packages that are generated after the

Commerce code is combined.

Merged packageMerged package – A package that is created by combining one package of each type. For example, you can

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/deployment/apply-deployable-package-system.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/install-deployable-package
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Prerequisite steps

merge one binary update package and one AOT package, or one AOT package and one Commerce

deployable package. The packages are merged in the Asset library for the project in LCS.

A binary package and a Commerce deployable package can't be included in the same merged package.

For information about how to download an update from LCS and what you see in the tiles based on your environment

version, see Download updates from Lifecycle Services (LCS).

If your environment is on an application version 8.1 and later, then the Platform Update packagePlatform Update package does not apply to

your environment. Starting with 8.1 and later releases, Application and Platform Binar y update packageApplication and Platform Binar y update package is the one

that applies since application and platform will be combined into a single cumulative package and will be released by

Microsoft. Also note that you will no longer be applying granular X++ hotfixes and will get all application and platform

updates together. This means that on the environment details page, clicking on View detailed version informationView detailed version information

will not have details on the granular hotfixes or KBs applied as there is no way to apply them.

Make sure that the package that should be applied is valid.Make sure that the package that should be applied is valid. When a package is uploaded to the

Asset library, it isn't analyzed. If you select the package, the package status appears in the right pane as

Not ValidatedNot Validated. A package must pass validation before it can be applied in an environment by using the

following procedures. The status of the package will be updated in the Asset library to indicate whether

the package is valid. We require validation to help ensure that production environments aren't affected by

packages that don't meet the guidelines.

There are three types of validations:

Basic package format validations

Platform version checks

Types of packages

Make sure that the package is applied in a sandbox environment before it's applied in theMake sure that the package is applied in a sandbox environment before it's applied in the

production environment.production environment. To help ensure that the production environment is always in a good state, we

want to make sure that the package is tested in a sandbox environment before it's applied in the

production environment. Therefore, before you request that the package be applied in your production

environment, make sure that it has been applied in your sandbox environment by using the automated

flows.

If you want to apply multiple packages, create a merged package that can be applied first inIf you want to apply multiple packages, create a merged package that can be applied first in

a sandbox environment and then in the production environment.a sandbox environment and then in the production environment. Application of a single package

in an average environment requires about 5 hours of downtime. To avoid additional hours of downtime

when you must apply multiple packages, you can create a single combined package that contains one

package of each type. If you select a binary package and an application deployable package in the Asset

library, a MergeMerge button becomes available on the toolbar. By clicking this button, you can merge the two

packages into a single package and therefore reduce the total downtime by half.

Make sure that the Application binar y update package is applied to your dev/buildMake sure that the Application binar y update package is applied to your dev/build

environment before it is applied to your sandbox and production environmentenvironment before it is applied to your sandbox and production environment - If the

application binary package is applied directly to your Tier 2+ sandbox environment but is not applied on

your dev/build environment, the next time you move an AOT package from dev/build box (which does

not have the same application binaries as your sandbox environment) to sandbox, some of the

application binaries will be overwritten with what is in your dev/build environment. This could result in a

regression of the version of your sandbox environment.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/migration-upgrade/download-hotfix-lcs


Apply a package to a non-production environment by using LCS

Apply a package to a production environment by using LCS

IMPORTANTIMPORTANT

Before you begin, verify that the deployable package has been uploaded to the Asset library in LCS.

1. For a binary update, upload the package directly to the Asset library. For information about how to download

an update from LCS, see Download updates from Lifecycle Services (LCS). For an application (AOT)

deployable package that results from an X++ hotfix, or from application customizations and extensions,

create the deployable package in your development or build environment, and then upload it to the Asset

library.

2. Open the Environment detailsEnvironment details  view for the environment where you want to apply the update.

3. Click MaintainMaintain > Apply updatesApply updates  to apply an update.

4. Select the package to apply. Use the filter at the top to find your package.

5. Click ApplyApply . Notice that the status in the upper-right corner of the Environment detailsEnvironment details  view changes from

QueuedQueued to In ProgressIn Progress , and an Environment updatesEnvironment updates  section now shows the progress of the package.

You can refresh the page to check the status.

6. Continue to refresh the page to see the status updates for the package application request. When the

package has been applied, the environment status changes to DeployedDeployed, and the servicing status changes to

CompletedCompleted.

In a production environment, customers can schedule a downtime for when they want the update to be applied.

An important prerequisite for applying a package to a production environment is that the package must be successfully

applied to at least one sandbox environment in the same project.

NOTENOTE

1. After the update is successfully applied in a sandbox environment, go to the project's asset library. On the

Asset librar yAsset librar y  page, select the Software deployable packageSoftware deployable package tab, select the package that you want to

move to production, and click Release candidateRelease candidate. This indicates that this package is ready for

production deployment.

2. Open the Environment detailsEnvironment details  view for the production environment where you want to apply the

package.

3. Select MaintainMaintain > Apply updatesApply updates  to apply the package.

4. Select the package to apply in your production environment, and then click ScheduleSchedule to submit a

request to apply it.

The list of packages includes only the packages that have been successfully signed off in the sandbox

environment, and that have been marked as release candidates.

5. Specify the date and time to schedule the package application. Click SubmitSubmit, and then click OKOK to

confirm. Note that your environments will be unavailable to perform business while the package is being

applied.

6. At the scheduled downtime, package deployment will start.

7. After the environment is serviced, you can monitor the status. The Ser vicing statusSer vicing status  field indicates the

status of package application. Additionally, a progress indicator shows the number of steps that have

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/migration-upgrade/download-hotfix-lcs


 

Troubleshoot package deployment failures

Applying updates and extensions

Packages, runbooks, and the AXUpdateInstaller in depth

been run, out of the total number of steps that are available.

8. After the deployment is successfully completed, the Ser vicing statusSer vicing status  field is set to CompletedCompleted.

9. If package application isn't successfully completed, Microsoft will investigate the issue. The Ser vicingSer vicing

statusstatus  field will indicate that package application has failed. The environment will be rolled back to a

good state.

If package deployment fails, see the Troubleshoot package application issues topic.

If you are updating a Tier-2 Sandbox or Production environment on application version 8.1.2.x or newer and

have initialized Cloud Scale Unit, you will also need to update Commerce channel components. For more

information, see Update Retail Cloud Scale Unit.

If you're using components (such as Modern POS), after you've applied updates and extensions in your

environment, you must also update your in-store components. For more information, see Configure, install, and

activate Modern POS (MPOS).

Deployable packages, runbooks, and the AXUpdateInstaller are the tools you use to apply updates.

Deployable packageDeployable package – A deployable package is a unit of deployment that can be applied in an environment. A

deployable package can be a binary update to the platform or other runtime components, an updated

application (AOT) package, or a new application (AOT) package. Deployable packages downloaded from LCS or

created in a development environment cannot be applied across product types. For example, a Finance

deployable package cannot be applied in a Commerce app environment, and vice versa. If you have an existing

customization for a Finance and Operations app that is compatible with the Commerce app, and you would like

to apply it to a Commerce environment, you will need to re-package your source code in a Commerce

development environment, and conversely if moving in the other direction.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/deployable-package-troubleshooting
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/update-retail-channel
file:///T:/eiye/ac1a/dynamics365/retail/retail-modern-pos-device-activation.html


Additional resources

RunbookRunbook – The deployment runbook is a series of steps that are generated in order to apply the deployable

package to the target environment. Some steps are automated, and some steps are manual. AXUpdateInstaller

lets you run these steps one at a time and in the correct order.

AXUpdateInstallerAXUpdateInstaller  – When you create a customization package from Microsoft Visual Studio or a Microsoft

binary update, the installer executable is bundled together with the deployable package. The installer generates

the runbook for the specified topology. The installer can also run steps in order, according to the runbook for a

specific topology.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/deployment/media/applypackage_deployablepackage.jpg
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/deployment/media/applypackage_runbook.jpg
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Install deployable packages from the command line
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Search for and download updates

NOTENOTE

Update an on-premises deployment

NOTENOTE

Apply application or binary updates through LCS

IMPORTANTIMPORTANT

This topic explains how to apply supported updates to Dynamics 365 Finance + Operations (on-premises). All

updates to on-premises environments are done through Microsoft Dynamics Lifecycle Services (LCS).

For more information about how to find the updates that you can apply to your on-premises environment, see

Issue search in Lifecycle Services (LCS). For information about how to download updates from the tiles in the

UpdatesUpdates  section of the Environment detailsEnvironment details  page in LCS, see Download updates from Lifecycle Services

(LCS).

When you are updating an on-premises environment, always select updates from the update tiles on the EnvironmentEnvironment

details page. If you select updates from another location, the updates might not work.

You can apply updates to an on-premises environment either during deployment or after the deployment is

completed.

While an on-premises environment is being deployed, you can select to deploy a custom package in the

AdvancedAdvanced settings. For more information about how to apply customizations or application X++ updates, see

Develop and deploy custom models to on-premises environments.

To apply updates to an on-premises environment after it has been deployed, in LCS, on the EnvironmentEnvironment

detailsdetails  page for the environment, under MaintainMaintain , select Apply updatesApply updates .

You can apply updates after deployment only on environments that have Platform update 12 for Finance and Operations

or later. The environment must also have the latest version of the local agent available in LCS. For more information, see

Update the local agent. If you're on a platform version that is older than Platform update 12, you can reconfigure an

environment that is already deployed to update the customizations or update to the latest platform release. For more

information about how to redeploy an environment, seeRedeploy on-premises environments.

The following steps can be used to apply X++, All Binary, or Platform binary updates.

The application of updates requires downtime for your environment. Therefore, no business transactions can be

performed in the environment during the update. When you complete the following steps, verify that the system isn't

being used, and that an official downtime notice has been communicated to all system users.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/deployment/apply-updates-on-premises.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/issue-search-lcs
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/migration-upgrade/download-hotfix-lcs
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/develop-deploy-custom-models-on-premises
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/update-local-agent
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/redeploy-on-prem
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PrerequisitesPrerequisites

Update a sandbox environmentUpdate a sandbox environment

To move to the latest platform, always select the platform update from the Platform Binar y UpdatesPlatform Binar y Updates tile on the

EnvironmentEnvironment  details page. If you select updates from another location, the updates might not work.

Before you begin, complete a full backup of the Management Reporter (MR), Microsoft Dynamics AX, and

Microsoft SQL Server Reporting Services (SSRS databases). Although the code is restored through LCS,

the database must be manually restored to help guarantee that there is no data loss.

Update your environment to the latest build of Platform update 12.

Update the local agent to the latest version. For more information, see Update the local agent.

Depending on the type of update, complete the following steps to generate a deployable package:

Platform binar y updatesPlatform binar y updates  – Download or save the update directly to the Asset library in LCS by

following the steps in Download updates from Lifecycle Services (LCS).

Application binar y updatesApplication binar y updates  – Download or save the update directly to the Asset library in LCS by

following the steps in Download updates from Lifecycle Services (LCS).

Application X++ updatesApplication X++ updates  – Download the required hotfix to your development environment, and

then follow the steps in Create deployable packages of models.

CustomizationsCustomizations  – Follow the steps in Develop and deploy custom models to on-premises

environments.

1. In the LCS Asset library, upload the deployable package that was generated in the "Prerequisites" section of

this topic to theSoftware deployable packagesSoftware deployable packagestab.

2. In LCS, open the on-premises implementation project, and then open the Environment detailsEnvironment details  page of the

environment to update.

3. Under MaintainMaintain , select Apply updatesApply updates . A slider shows the updates that were uploaded to the Asset library.

Note that only packages that are marked as ValidValid in the Asset library appear.

If you are on local agent version 2.1 .0 and higher, complete the following steps.If you are on local agent version 2.1 .0 and higher, complete the following steps.

NOTENOTE

1. Select the update, and then click PreparePrepare. Clicking on PreparePrepare will prepare your on-premises

environment for servicing.

During preparation, the environment state will be DeployedDeployed but the Deployment status field will show the

progress of Preparation. Steps such formatting the package and downloading the package are executed during

preparation. The environment is not directly touched during preparation and hence there is no downtime during

the preparation phase. Users can continue to use the system during preparation.

2. After the preparation is complete, you will see Abor tAbor t and Update EnvironmentUpdate Environment buttons. To start

applying the update, click Update EnvironmentUpdate Environment. If preparation fails, see the "Resolve a failed update

application" section later in this topic.

3. In the confirmation message, select YesYes . The servicing operation has started on this environment. This is

the start of the downtime on your environment.

4. The environment state is changed from DeployedDeployed to DeployingDeploying.

5. After the update is completed, the environment state is changed back to DeployedDeployed. If application of the

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/update-local-agent
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/migration-upgrade/download-hotfix-lcs
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/migration-upgrade/download-hotfix-lcs
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/create-apply-deployable-package
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/develop-deploy-custom-models-on-premises


Update a production environmentUpdate a production environment

Resolve a failed update application

update fails, the environment state is changed to FailedFailed. For information about what to do if package

application fails, see the "Resolve a failed update application" section later in this topic.

6. Open the Histor yHistor y  and Environment detailsEnvironment details  pages to view the operations that were performed on the

environment. You can also view a record of major actions that were performed on the environment, such

as deployments, servicing, and rollbacks.

If you are on local agent version lower than 2.1 .0 , complete the following steps.If you are on local agent version lower than 2.1 .0 , complete the following steps.

NOTENOTE

1. Select the update, and then click ApplyApply .

2. In the confirmation message, select YesYes . The servicing operation has started on this environment. This is

the start of the downtime on your environment.

3. Environment state changes from DeployedDeployed to PreparingPreparing.

During preparation, steps such formatting the package and downloading the package are executed during

preparation. The environment is not directly touched during preparation and hence there is no downtime during

the preparation phase. Users can continue to use the system during preparation. However, we recommend that

the downtime starts when the environment enters the Preparing state.

4. After preparation is complete, the environment state is changed from PreparingPreparing to DeployingDeploying.

5. After the update is completed, the environment state is changed back to DeployedDeployed. If application of the

update fails, the environment state is changed to FailedFailed. For information about what to do if package

application fails, see the "Resolve a failed update application" section later in this topic.

6. Open the Histor yHistor y  and Environment detailsEnvironment details  pages to view the operations that were performed on the

environment. You can also view a record of major actions that were performed on the environment, such

as deployments, servicing, and rollbacks.

Before you update a production environment, you must successfully complete the package application update

on a sandbox environment.

1. In the project for the sandbox environment that you applied the package to, open the Asset library, and then,

on the Software deployable packagesSoftware deployable packages  tab, select the package, and mark it as a Release candidateRelease candidate.

2. On the Environment detailsEnvironment details  page, under MaintainMaintain , select Apply updatesApply updates . In the dialog box, only

packages that are marked as a Release candidateRelease candidate are shown.

3. Select the Release candidate package to be applied to the Production environment.

4. The rest of the Update flow is the same as that of a sandbox environment. Your update experience will differ

based on the version of the local agent running on your environment. We recommend that you always run

with the latest version.

When preparation fails, the environment state is DeployedDeployed. When the application of an update fails, the

environment state is FailedFailed. The first step is to determine why there is a failure. The location of the logs varies,

depending on the stage where the failure occurred:

Preparation stage:Preparation stage: If the operation fails during the PreparationPreparation stage, the logs are uploaded to LCS. In the

log files, select Download logsDownload logs  to download the log files. If the package has any merge issues, the error is

included in the log file.

Deploying stage:Deploying stage: If the operation fails during the DeployingDeploying stage, the logs are located in the on-premises
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environment. You must sign in to the environment, and then access the logs and event viewer.

For more information about how to use the troubleshooting logs, see Troubleshoot on-premises deployments.

After you review the logs and determine the cause of the failure, complete one of the following operations to

restore the environment to a healthy state. No actions can be performed on an environment that is in a FailedFailed

state. The environment must first be restored to a healthy state.

NOTENOTE

IMPORTANTIMPORTANT

Retr y failed operationRetr y failed operation – If update application fails, select Retr yRetr y  to recover from the failed operation.

Abor t failed operationAbor t failed operation – Because there is no change made to the on-premises environment, if the

preparation fails, you have the option to cancel the operation. Select Abor tAbor t to cancel the preparation.

Roll back the updateRoll back the update – To roll back the update that failed, select RollbackRollback . Before you start the rollback,

you must restore the database to the last known good state. When you select RollbackRollback , the environment

is restored to the last known good state. The environment state is then changed to PreparationPreparation, then to

DeployingDeploying, and then to either DeployedDeployed or FailedFailed.

The RollbackRollback button doesn't roll back the database. You're responsible for restoring the database to the last

known backup that was made before update application. This step is critical to help guarantee that there is no

data loss.

Refresh the stateRefresh the state – If update application fails during the PreparationPreparation stage, the failure is on the LCS

side, and update application hasn't yet started. Therefore, the on-premises environment is in a good state.

To restore the LCS environment state to DeployedDeployed, on the project dashboard page, select RefreshRefresh.

Delete and redeploy an environmentDelete and redeploy an environment – If the retry and rollback options don't work, you must delete

and redeploy the environment. To delete the environment, on the project dashboard page, select DeleteDelete.

You then see the option to configure the environment.

This option should notnot  be used on a production environment. However, it can be used on a sandbox deployment

to restore the environment to a healthy state.

Because this option requires that you do a fresh deployment of the environment, you lose any

updates that were previously applied. Any customizations and binary updates must be reapplied to

the environment.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/troubleshoot-on-prem
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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In Microsoft Dynamics Lifecycle Services (LCS), you can specify how and when you receive service updates from

Microsoft for your environments.

This feature is available only to customers who are using version 8.1 and laterversion 8.1 and later  or are using version 7.3version 7.3 , and who are

notnot  part of the First release program. Microsoft is working to make the feature available to First release customers. For

customers who are on version 7.1, 7.2, or 8.0, you can take the update manually using the regular servicing flows.

Only users (customers or partners) who are assigned to the Project ownerProject owner  role in LCS can configure updates.

Additionally, updates can be configured only for implementation projectsimplementation projects .

Follow these steps to change your update settings.

These settings apply only to service updates. They have no effect on the operating system–level security updates that are

applied to your environments every month.

1. In LCS, in your implementation project, open the Project settingsProject settings  page.

This page has a new tab that is named Update settingsUpdate settings .

2. On the Update settingsUpdate settings  tab, set the following configuration options as you require:

IMPORTANTIMPORTANT

Update environmentUpdate environment – Select an alternate sandbox environment that should be updated before

the production update.

By default, Microsoft first updates the Tier 2 Standard Acceptance Test (sandbox) environment that

is included in the base offer. It then applies the update to the production environment. If you've

purchased Tier 2 and higher sandbox add-on environments and want a different sandbox to be

updated, you can use this field to change the default environment to an alternate environment.

The environment that you select here will be updated seven calendar days before the update cadence that

is selected for the production environment.

Production environment update cadenceProduction environment update cadence – Select a recurring cadence for updates to your

production environment. The sandbox environment that is selected in the Update environmentUpdate environment

field will be updated seven calendar days before the selected cadence. The following options are

available:

Select the cadenceSelect the cadence – Select whether to receive updates in the first, second, or third week of

the month.

Select one of the three time-zonesSelect one of the three time-zones  – Select the time zone that the production environment

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/lifecycle-services/configure-service-updates.md
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Canceled updates

NOTENOTE

IMPORTANTIMPORTANT

should be updated in: Eastern Time (UTC – 5), Hong Kong Time (UTC + 8), or Greenwich Mean

Time (UTC + 0).

Select a day of the week :Select a day of the week : Select the day in the week when you want to receive updates.

Select a time slot:Select a time slot: Select the time slot when you want to receive updates.

Currently, only a few options are available for the day of the week and time slot options. Microsoft will add

more options soon, such as weekdays for customers.

If the above time slots do not meet your needs, you always have the option to do a self-update at a time

that is convinient to you by taking the update and applying it to your environments using the regular

servicing flows.

3. When you've finished setting the configuration options, select SaveSave.

After you set the update environment and update cadence, Microsoft generates an update calendar for the next

six months. This calendar shows exactly when the configured sandbox and production environments will be

updated. Therefore, you will know when to expect each update. To view the calendar, select the View updateView update

calendarcalendar  link under the Production environment update cadenceProduction environment update cadence options.

After the settings are saved, you can change them at any time. However, if there is an ongoing rollout, the new settings

won't be used to update the existing rollout timings. Instead, they will start to be used in the next rollout. An ongoing

rollout is defined by the 14-day period between the date when the email notification about the update of the sandbox

environment is sent and the date when the production environment is updated.

For more information about how to pause updates to configured sandbox and production environments, see

Pause service updates through Lifecycle Services (LCS).

For more information about One Version and Microsoft-managed service updates, see One Version service

updates FAQ.

A scheduled update could be canceled for various reasons. Here are some of the common reasons that could

cause a scheduled update to be canceled by Microsoft.

An error was found during update preparation. The update preparation starts approximately 4 hours before

the update to ensure that the environment is in a healthy state. If the environment was in a failed state or

maintenance mode, the scheduled update will be canceled before it starts.

An error was found while updating the environment. If there were issues during the update, the scheduled

update will be canceled and the environment is rolled back to the previous state.

The environment is already running on the latest version. There's no need to apply the update again, the

scheduled update will be canceled before it starts.

The target environment is not found. If the designated sandbox was deleted or the production environment

has not been deployed, the scheduled update will be canceled before it starts.

You’re enrolled in the First Release program. The First Release program has different release cadence so the

previously scheduled updates will be canceled.

https://experience.dynamics.com
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You can find the canceled updates via the View recent canceled updatesView recent canceled updates  in the update settings. It will show

all canceled updates, if any, within the last 2 scheduled updates.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

Who can pause service updates?

What can I pause?

This topic explains how to pause updates to your sandbox and production cloud environments by using

Microsoft Dynamics Lifecycle Services (LCS). This topic does not apply to on-premises environments.

This feature is available only to customers who are using version 8.1 and laterversion 8.1 and later  or are using version 7.3version 7.3 , and who are

notnot  part of the First release program. Microsoft is working to make the feature available to First release customers. For

customers who are on version 7.1, 7.2, or 8.0, you can take the update manually using the regular servicing flows.

Microsoft updates your configured sandbox and production environments to the latest service update that

Microsoft has released. Microsoft notifies you about upcoming updates to your environments via email and

through notifications in LCS. At that point, if you can't proceed with the update for some reason, you can pause it

through LCS.

For more information about how to change the configured sandbox environment and set the production update

cadence, see Configure service updates through Lifecycle Services (LCS).

Only users (customers or partners) who are assigned to the project ownerproject owner  role in LCS can pause updates.

Additionally, updates can be paused only for implementation projectsimplementation projects .

Staying current with service updates helps guarantee that customers always run on the latest set of fixes that

Microsoft has released, so that they have the best service experience. Therefore, Microsoft doesn't allow updates

to be paused indefinitely.

You can't use LCS to pause updates if you're three or more updates behind the latest update that Microsoft has

released. For example, if the latest update that Microsoft has released is version 10.0.0, customers who are on

version 8.1.3, version 8.1.2, and version 8.1.1 cancan pause updates. However, customers who are on version 8.1.0

can'tcan't pause updates, because they are more than three updates behind. Customers who are on version 7.3 can

get only platform updates. For example, if the last platform update that Microsoft has released is Platform

update 25, customers who are on Platform update 24, Platform update 23, and Platform update 22 cancan pause

updates. However, customers who are on Platform update 21 can'tcan't pause updates.

If you decide to pause updates, you have two options:

Pause updates only to your production environment.

Pause updates to both your sandbox environment and your production environment.

You can pause a maximum of three continuous updates at a time. For example, if you're using version 8.1.3, you

can pause update version 10.0.0, 10.0.1 and 10.0.2. However, you can't pause update version 10.0.3. In addition,

in the month of June, you can pause the next three updates. However, you will not be able to pause updates

scheduled for October, November, December and later. Similarly, for customers on version 7.3 for platform only

updates, if you’re using Platform update 23 then you can pause update 24, update 25, and update 26, but you

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/lifecycle-services/pause-service-updates.md
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How do I pause updates?

IMPORTANTIMPORTANT

cannot pause update 27. We will be releasing 8 updates in a year. We require you to take at least two updates in

a year.

There is no way to pause more than three updates, regardless of your industry or business schedule. If you are more than

three updates behind and you find a critical issue during validations in your sandbox environment after the update, you

can contact Microsoft Support to pause the update to your production environment. This is only required if you are more

than three updates behind and you are unable to use the pause updates functionality available in LCS to pause the

update to production.

If you pause updates to your sandbox environment, updates are automatically also paused for your

production environment, because Microsoft always updates configured sandbox environments before

production environments.

To pause updates, follow these steps.

1. In LCS, in your implementation project, open the Project settingsProject settings  page.

This page has a new tab that is named Update settingsUpdate settings .

2. On the Update settingsUpdate settings  tab, set the Pause updatesPause updates  option to ONON.

3. Select Edit settingsEdit settings .

4. In the dialog box that appears, select whether you want to pause updates to your production

environment only, or to both your sandbox environment and your production environment.

5. Select NextNext.

6. Select your reason for pausing updates. If you select Issue found during validationsIssue found during validations , you must enter a

valid support ticket number. You can add any additional details that will help Microsoft understand why

you want to pause updates.

7. When you've finished, select ConfirmConfirm .

You can also edit an existing pause. You can either extend the duration of the pause, so that updates are paused

for a longer time, or cancel it, so that updates are resumed. To edit a pause, select Edit settingsEdit settings . The limitations

about the number of updates that you can pause still apply.

To cancel a pause and resume updates to your environments, set the Pause updatesPause updates  option to OFFOFF .

Any time that you pause updates or edit an existing pause, a notification appears at the top of the UpdateUpdate

settingssettings  tab. This notification shows what has been paused. An email is also sent to all stakeholders (the project

owner and environment manager), to notify them that service updates for the selected environments have been

paused. If someone cancels an existing pause and resumes updates, the notification disappears, and an email is

sent to inform the stakeholders that updates have resumed.

You can pause updates through LCS until four hours before the start of the downtime window.

You can cancel a pause and choose to resume updates only 7 days prior to the start of the downtime date. If

you are past that date then you will not be able to cancel a pause.



What happens after the pause duration expires?

NOTENOTE

Cumulative service updates help guarantee that customers always run on the latest set of fixes that Microsoft

has released, so that they have the best service experience. Therefore, Microsoft doesn't allow updates to be

paused indefinitely.

There are two ways to cancel pauses, so that updates are resumed:

Someone manually cancels an ongoing pause, as explained in the previous section.

The duration that was set for the pause expires, and updates to the configured environments are

automatically resumed.

In both cases, an email is sent to inform the stakeholders.

For more information about service updates, see One Version service updates FAQ.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Get notified about service updates through Lifecycle
Services (LCS)
2/18/2021 • 2 minutes to read • Edit Online

NOTENOTE

This topic explains how you can stay up to date about service updates from Microsoft.

Microsoft uses service updates to update your configured sandbox and production environments to the latest

released version. Microsoft notifies you about upcoming updates to your environments via email and through

notifications in Microsoft Dynamics Lifecycle Services (LCS).

Here are the different types of notifications that you will receive:

Notification when an update is made available:Notification when an update is made available: When a new release is made generally available,

Microsoft surfaces a notification in your implementation projects' action center. You can then save that

update in your projects' asset library, if you want to apply the update to your environments before

Microsoft does an automatic update. When Microsoft does an automatic update, it also saves a copy of

the update in your projects' asset library.

Notification that is sent five days before the update:Notification that is sent five days before the update: Microsoft notifies you five days before it

updates your environment. After you've configured your update cadence, you will receive notifications

about upcoming updates five days before they occur. These notifications take three forms:

Email notification:Email notification: Project owners, environment managers, and users who are listed as additional

stakeholders for an environment are notified by email about the upcoming update.

Notification bar on the environment details page:Notification bar on the environment details page: A notification that appears on the

environment details page in LCS informs the customer about the upcoming update.

Upcoming update reflects the update:Upcoming update reflects the update: On the environment details page in LCS, select MaintainMaintain

> Upcoming Update> Upcoming Update to open a dialog box that contains details about the upcoming update.

Notification that is sent one hour before the update:Notification that is sent one hour before the update: One hour before the start of the downtime

window, users in the application receive a notification. This notification asks users to save their work,

because the environment will be taken down for an update.

Notification that is sent when the update is completed:Notification that is sent when the update is completed: After Microsoft has finished updating your

configured environment, it notifies you by email about the outcome of the update. This email is always

sent, regardless of whether the update was successfully applied. It's sent to project owners, environment

managers, and users who are listed as the additional stakeholders for the environment. If Microsoft can't

start the update for some reason, the email includes a reason to explain why the update wasn't started.

After you receive a notification, if you can't proceed with the update for some reason, you can pause it. For more

information about how to pause updates to configured sandbox and production environments, see Pause

service updates through Lifecycle Services (LCS).

For more information about One Version and Microsoft-managed service updates, see One Version service

updates FAQ.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/lifecycle-services/notifications-service-updates.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

Data task automation lets you easily repeat many types of data tasks and validate the outcome of each task.

Data task automation is very useful for projects that are in the implementation phase. For example, you can

automate the creation and configuration of data projects. You can also configure and trigger the execution of

import/export operations, such as the setup of demo data and golden configuration data, and other tasks that

are related to data migration. You can also create automated testing of data entities by using task outcome

validation.

Data task automation isn't currently supported for on-premises environments. The user who executes data task

automation must be in the same tenant as the application environment and LCS project.

We recommend the following approach for data task automation.

IMPORTANTIMPORTANT

1. Identify the data-related tasks that will benefit from automation.

We recommend that implementation teams review their configuration management plan and data

migration plan to identify potential data tasks for automation, and also to identify data entity test cases.

2. Define tasks.

Tasks are defined in an XML manifest. You can keep your manifest under source control as part of

configuration management in your application lifecycle management (ALM) strategy.

3. Put the data packages that are related to data task automation in the Shared asset library of Microsoft

Dynamics Lifecycle Services (LCS). You can also use a specific LCS project as you require.

Data task automation manager can consume packages from any sandbox and/or production

environment that is related to the LCS project.

The user account that runs Data task automation manager must have access to LCS and to the LCS project

that is referenced in the manifest for data packages.

Although data task automation can be run in any environment in the cloud, we strongly recommend that you

not run any import/export tasks that use integration application programming interfaces (APIs) in a

production environment. Data task automation that involves integration APIs should be used only for

automated testing.

4. Run the data tasks, and then review the outcomes.

Data task automation manager provides the success or failure outcome for each task. It also provides

insights into the reason why a task failed.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/data-entities/data-task-automation.md


Task manifest

Manifest rootManifest root

<?xml version='1.0' encoding='utf-8'?>
<TestManifest name='Data management demo data set up'>
    <SharedSetup />
        <JobDefinition ID='ImportJobDefinition_1' />
        <EntitySetup ID='Generic' />
    </SharedSetup>
    <TestGroup />
</TestManifest>
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<TestManifest> 1..1 name The name helps to identify
the purpose of the
manifest.

Shared setupShared setup
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<TestManifest> <SharedSetup> 1..1 - This element takes
no attributes.

Data filesData files

<DataFile ID='SharedSetup' name='Demo data-7.3-100-System and Shared'  assetType='Data package' 
lcsProjectId=''/>
<DataFile ID='FinancialsHQUS' name='Demo data-7.3-200-Financials-HQUS' assetType='Data package' 
lcsProjectId=''/>
<DataFile ID='FinancialsPICH' name='Demo data-7.3-200-Financials-PICH' assetType='Data package' 
lcsProjectId=''/>
<DataFile ID='FinancialsPIFB' name='Demo data-7.3-200-Financials-PIFB' assetType='Data package' 
lcsProjectId=''/>

IMPORTANTIMPORTANT
Although data task automation can be run in any environments in the cloud, we recommend that you not run

any import/export tasks that use integration APIs in a production environment. Data task automation that

involves integration APIs should be used only for automated testing.

The following video is a 55-minute TechTalk that walks you through an early release of Data task automation

manager : Task automation framework.

A task must be defined in an XML manifest. This section describes the manifest. For guidance about how to

name and design the manifest, see the "Best practices for manifest design" section later in this topic.

The <TestManifest><TestManifest> element is the root of the manifest. All other elements are children of this element.

The Shared setupShared setup section defines general task parameters and behaviors for all tasks in the manifest.

<DataFile><DataFile> elements define the data packages and data files that the tasks in the manifest will use. The data

files must be either in the LCS asset library of your LCS project or in the Shared asset library.

https://academylive.blob.core.windows.net/media/PAL/TechTalks-EnterpriseEdition/TaskAutomationFrameworkForDataManagement-DYN447PAL2.mp4
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<SharedSetup> <DataFile> 1..n - -

<DataFile> - ID

<DataFile> - name Name of the asset
that represents the
data file.

<DataFile> - assetType The asset type in LCS
asset library that
stores the data file.
This is the asset type
name as shown in
LCS asset library.

<DataFile> - lcsProjectId The LCS project that
has the data file in its
asset library. If the
project ID is specified
as '' then, it indicates
the Shared asset
library.

Data project definitionData project definition

<JobDefinition ID='ImportJobDefinition_1'>
    <Operation>Import</Operation>
    <ConfigurationOnly>No</ConfigurationOnly>
    <Truncate></Truncate>
    <Mode>Import async</Mode>
    <BatchFrequencyInMinutes>1</BatchFrequencyInMinutes>
    <NumberOfTimesToRunBatch >2</NumberOfTimesToRunBatch>
    <UploadFrequencyInSeconds>1</UploadFrequencyInSeconds>
    <TotalNumberOfTimesToUploadFile>1</TotalNumberOfTimesToUploadFile>
    <SupportedDataSourceType>Package</SupportedDataSourceType>
    <ProcessMessagesInOrder>No</ProcessMessagesInOrder>
    <PreventUploadWhenZeroRecords>No</PreventUploadWhenZeroRecords>
    <UseCompanyFromMessage>Yes</UseCompanyFromMessage>
    <LegalEntity>DAT</LegalEntity>
    <PackageAPIExecute>true</PackageAPIExecute>
    <PackageAPIOverwrite>false</PackageAPIOverwrite>
    <PackageAPIReexecute>false</PackageAPIReexecute>
    <DefinitionGroupID>TestExport</DefinitionGroupID>
    <PackageName>TestExportPackage</PackageName>
</JobDefinition>
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<SharedSetup> <JobDefinition> 1..n ID The job definition ID
is used in the tasks
to reference the
definition to be used
for the data project.

The <JobDefinition><JobDefinition> element defines the data project definition. There can be more than one job definition in

a manifest.



<JobDefinition> <Operation> 1..1 - The operation to be
performed is
specified by the
following values: 
- Import 
- Export

<Truncate> 1..1 - This is a Boolean field
with possible values
of Yes or No. This is
applicable only when
operation is set to
Import.

<Mode> 1..1 - The mode specifies
the method using
which the operation
must be performed.
The possible values
are:
- Import async 
- Export async 
- Recurring batch:
This uses the
enqueue API.
Dequeue API is not
supported yet.
Package API
supports both export
and import.

<ConfigurationOnly
>

0..1 - This is a Boolean field
with possible values
of Yes or No. This
must be set to Yes if
the task is only to
configure the data
project but not to
perform the specified
operation.

<BatchFrequencyInM
inutes>

1..1 - This specifies the
frequency in which
the batch must be
scheduled. This is
applicable only when
mode is set to
recurring batch.

<NumberOfTimesToR
unBatch>

1..1 - This is used to set a
limit to how many
times the scheduled
batch should run.
This is applicable only
when mode is set to
recurring batch.
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<UploadFrequencyIn
Seconds>

1..1 - This is used to
control the rate at
which a file is
uploaded to the
recurring batch job
for import. This must
be used only for
automated testing of
recurring integrations
in non-production
environments. This is
applicable only when
mode is set to
recurring batch and
operation is set to
Import.

<TotalNumberOfTime
sToUpload>

1..1 This controls the
total number of
times the file should
be uploaded to the
recurring batch. This
must be used only
for automated
testing of recurring
integrations in non-
production
environments. This is
applicable only when
mode is set to
recurring batch and
operation is set to
Import.

<SupportedDataSour
eType>

1..1 This must be used to
specify if a file is
being sent to the
recurring batch or a
package. This is only
applicable when
mode is set to
'recurring batch'.

<ProcessMessagesIn
Order>

1..1 This is a Boolean field
with possible values
of Yes or No. This is
applicable only when
mode is set to
recurring batch and
operation is Import.

<PreventUploadWhe
nZeroRecords>

1..1 This is a Boolean field
with possible values
of Yes or No. This is
applicable only when
mode is set to
recurring batch and
operation is Export.
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<UseCompanyFrom
Message>

1..1 This is a Boolean field
which can be set to
Yes or No. This is
applicable only when
mode is set to
recurring batch and
operation is Import.

<LegalEntity> 1..1 This is used to specify
the legal entity in
which the
import/export job
must be executed.

<PackageAPIExecute
>

1..1 Refer to package API
documentation to
understand this
parameter. This is a
Boolean field which
takes 'true' or 'false'.

<PackageAPIOverwri
te>

1..1 Refer to package API
documentation to
understand this
parameter. This is a
Boolean field which
takes 'true' or 'false'.

<PackageAPIReexecu
te>

1..1 Refer to package API
documentation to
understand this
parameter. This is a
Boolean field which
takes 'true' or 'false'.

<DefinitionGroupID> 1..1 Refer to package API
documentation to
understand this
parameter. This is a
string field.

<PackageName> 1..1 Refer to package API
documentation to
understand this
parameter. This is a
string field.
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Entity setupEntity setup
The Entity setupEntity setup section defines the characteristics of an entity that a task in the manifest will use. There can be

more than one definition, one for each entity that is used by the tasks in the manifest.



<EntitySetup ID='Generic'>
    <Entity name='*'>
        <SourceDataFormatName>Package</SourceDataFormatName>
        <ChangeTracking></ChangeTracking>
        <PublishToBYOD></PublishToBYOD>
        <DefaultRefreshType>Full push only</DefaultRefreshType>
        <ExcelWorkSheetName></ExcelWorkSheetName>
        <SelectFields>All fields</SelectFields>
        <SetBasedProcessing></SetBasedProcessing>
        <FailBatchOnErrorForExecutionUnit>No</FailBatchOnErrorForExecutionUnit>
        <FailBatchOnErrorForLevel>No</FailBatchOnErrorForLevel>
        <DisableEntity>No</DisableEntity>
        <SkipStaging>Yes</SkipStaging>
        <ParallelProcessing>
            <Threshold></Threshold>
            <TaskCount></TaskCount>
        </ParallelProcessing>
        <MappingDetail StagingFieldName='RoundingRulePrices' AutoGenerate='Yes' AutoDefault='No' 
DefaultValue='' IgnoreBlankValues='No' TextQualifier='No' UseEnumLabel='No'/>
        </Entity>
</EntitySetup>
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<SharedSetup> <EntitySetup> 1..n ID An identification that
will be used by tasks
to reference an entity
definition to be used.

<EntitySetup> <Entity> 1..1 name The entity element is
identified by the
entity's name.
However, to facilitate
easy manifest
definition, this
element also
supports * as a wild
card which will mean
all entities being used
in a task. This comes
in very handy when
using data packages
with hundreds of
entities in a task.

<Entity> <SourceDataFormat
Name>

1..1 - This is the file format
to be used for the
entity.

<ChangeTracking> 1..1 - This is a Boolean field
with possible values
of Yes or No. It
enables or disables
change tracking on
the entire entity.

<PublishToBYOD> 1..1 - This is a Boolean field
with possible values
of Yes or No.



<DefaultRefreshType
>

1..1 - This sets the default
refresh rate on the
entity. The possible
values are
Incremental push
only or Full push.

<ExcelWorkSheetNa
me>

1..1 - This is used to specify
the worksheet to be
used for the entity.

<SelectFields> 1..1 - This can be used to
specify the fields to
be included in the
template for an
export operation.

<SetBasedProcessing
>

1..1 - This is a Boolean field
with possible values
of Yes or No. It is
used to enable or
disable set based
processing on an
entity.

<FailBatchOnErrorFor
ExecutionUnit>

1..1 - This is a Boolean field
with possible values
of Yes or No. It is
used to enable or
disable failure at
execution unit level
on an entity.

<FailBatchOnErrorFor
Level>

1..1 - This is a Boolean field
with possible values
of Yes or No. It is
used to enable or
disable failure at
execution level on an
entity.

<DisableEntity> 1..1 - This is a Boolean field
with possible values
of Yes or No. It is
used to enable or
disable an entity in a
data project.

<SkipStaging> 1..1 - This is a Boolean field
with possible values
of Yes or No. It is
used to skip staging
table for an entity
during exports.
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<ParallelProcessing> 1..1 - This is used to define
the parallel
processing set up for
an entity. The task
will delete these
settings if already
exits at the beginning
of the task and it will
delete the created
settings at the end of
its execution.

<ParallelProcessing> <Threshold> 1..1 - This specifies the
threshold for the
parallel processing
rule.

<TaskCount> 1..1 - This is used to specify
the number of
parallel tasks to be
used for parallel
processing.

<Entity> <MappingDetail> 0..n - Allows to configure
the auto generate,
auto default and
other settings on the
mapping for an
entity.

<MappingDetail> - StagingFieldName This attribute is used
to identify the entity
column for which the
settings are to be
specified.

<MappingDetail> - AutoGenerate This is a Boolean field
with possible values
of Yes or No for
enabling/disabling
auto generate
option.

<MappingDetail> - AutoDefault This is a Boolean field
with possible values
of Yes or No for
enabling/disabling
auto default option.

<MappingDetail> - DefaultValue This is the default
value to be used if
auto defaulting is
enabled.
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<MappingDetail> - IgnoreBlankValues This is a Boolean field
with possible values
of Yes or No for
enabling/disabling
this option.

<MappingDetail> - TextQualifier This is a Boolean field
with possible values
of Yes or No for
enabling/disabling
this option.

<MappingDetail> - UseEnumLabel This is a Boolean field
with possible values
of Yes or No for
enabling/disabling
this option.
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Test groupsTest groups

<TestGroup name='Set up Financials'>
    <TestCase Title='Import shared set up data package' ID='3933885' RepeatCount='1' TraceParser='off' 
TimeOut='20'>
        <DataFile RefID='SharedSetup' />
        <JobDefinition RefID='ImportJobDefinition_1' />
        <EntitySetup RefID='Generic' />
    </TestCase>
    
    <TestCase Title='Import financials for HQUS' ID='3933886' RepeatCount='1' TraceParser='off' 
TimeOut='20'>
        <DataFile RefID='FinancialsHQUS' />
        <JobDefinition RefID='ImportJobDefinition_1'>
            <LegalEntity>HQUS</LegalEntity>
        </JobDefinition>
        <EntitySetup RefID='Generic' />
    </TestCase>

    <TestCase Title='Import financials for PICH' ID='3933887' RepeatCount='1' TraceParser='off' 
TimeOut='20'>
        <DataFile RefID='FinancialsPICH' />
        <JobDefinition RefID='ImportJobDefinition_1'>
            <LegalEntity>PICH</LegalEntity>
        </JobDefinition>
        <EntitySetup RefID='Generic' />
    </TestCase>

    <TestCase Title='Import financials for PIFB' ID='3933888' RepeatCount='1' TraceParser='off' 
TimeOut='20'>
        <DataFile RefID='FinancialsPIFB' />
        <JobDefinition RefID='ImportJobDefinition_1'>
            <LegalEntity>PIFB</LegalEntity>
        </JobDefinition>
        <EntitySetup RefID='Generic' />
    </TestCase>
</TestGroup>

Test groups can be used to organize related tasks in a manifest. There can be more than one test group in a

manifest.
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<TestManifest> <TestGroup> 1..n - -

<TestGroup> 1..1 Name This is the name for
the group to identify
its functional reason.

<TestGroup> <TestCase> 1..n - The task is defined in
this element. The
task can refer to the
shared set up to
inherit task
parameters and task
behavior. The task
can also override
parameters and
behavior at its level
thus making the
management of the
manifest simple.

<TestCase> - Title This is the title for
the task.

<TestCase> - ID This is the ID for the
task. This can be
alphanumeric with a
max character limit of
10.

<TestCase> - RepeatCount This is a placeholder
for a future
functionality.
However, this must
be specified with a
value of 1.

<TestCase> - TraceParser This is a placeholder
for a future
functionality.
However, this must
be specified with a
value off.

<TestCase> - Timeout This is the maximum
duration a task will
be monitored by the
task automation
manager. If the task
is still active beyond
the timeout specified,
the manager will
proceed to the next
task in the manifest.



<TestCase> <DataFile> 1..n - This element is used
to define the file or
data package to be
used by the task.
This can reference to
an already declared
file or a data package
in the shared section
of the manifest. A
task can have more
than one data file
specified for recurring
batch import
scenarios only. For
other scenarios, even
if more than one files
are specified, the first
file is what will be
used by the task.

<JobDefinition> 1..1 - This element is used
to define the data
project to be used by
the task. This can
reference to an
already declared job
definition in the
shared section of the
manifest. The task
can override
elements of job
definition to a new
value than what is
defined in the shared
set up.

<EntitySetup> 1..1 - This element is used
to define the entity
set up for entities
used by the task.
This can reference to
an already declared
entity set up in the
shared section of the
manifest. The task
can override
elements of entity
setup to a new value
than what is defined
in the shared set up.
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Best practices for manifest design

GranularityGranularity

You can define a manifest in many ways. Here are a few pointers that you should consider when you design a

manifest.

We recommend that you determine the granularity of your manifest as a functional decision. Your team must



InheritanceInheritance

Source controlSource control

Number of job definitions and entity definitionsNumber of job definitions and entity definitions

Validations

Example 1: Configuration management for data projects

<?xml version='1.0' encoding='utf-8'?>
<TestManifest name='Data management demo data set up'>
    <SharedSetup>
        <DataFile ID='SharedSetup' name='Demo data-7.3-100-System and Shared'  assetType='Data package' 
lcsProjectId=''/>
        <DataFile ID='FinancialsHQUS' name='Demo data-7.3-200-Financials-HQUS' assetType='Data package' 
lcsProjectId=''/>

decide whether it wants to manage many manifests or manage changes in a single manifest.

Start with as many manifests as your team thinks you logically need. Later, when the team actually starts to

run the manifests, it might find that it uses fewer manifests than it expected, and it might want to merge

them. In this case, you can merge manifests.

Consider separation of duties. For example, you might have one manifest for the setup of demo data and

another manifest for the setup of the golden configuration for your environment. In this way, you can make

sure that team members use only the manifests that they are supposed to use.

Consider user access to LCS. For example, larger and globally distributed implementation teams might have

multiple instances of the application or multiple LCS projects.

The manifest schema supports inheritance of common elements that will apply to all tasks in the manifest. A

task can override a common element to define a unique behavior. The purpose of the Shared setupShared setup section is

to minimize repetition of configuration elements, so that elements are reused as much as possible. The goal is to

keep the manifest concise and clean, to improve maintenance and readability.

Manifests that must be used by all the members of an implementation team should be stored in source control

in the Application Object Tree (AOT). This approach not only provides the benefits of source control, but also

enables a process to distribute or make manifests available to all users in a consistent manner. This approach

also enables configuration management for data projects that are related to data management, if manifests are

used for configuration.

For most of the use cases, one job definition in a manifest should be enough, because inheritance can be used to

change the behavior at the task level. This principle also applies to entity definitions.

Data task automation manager performs validations, based on the setup of a task. If a task fails, you can quickly

determine the reason for the failure by viewing the validations after the task is completed. The level of

information that Data task automation manager provides is optimized to facilitate initial discovery. For detailed

investigation, you must look at the corresponding data project and its execution details.

The following data validations are currently supported:

Job statusJob status  – This validation checks whether the job was successful.

Batch statusBatch status  – This validation checks whether the batch was successful.

Message statusMessage status  – If the test is about integrations, the message status is validated.

TruncationTruncation – If truncation is enabled, this validation checks whether truncation occurred.

Skip stagingSkip staging – If Skip stagingSkip staging is enabled on a test, this validation checks whether staging was skipped.

The <ConfigurationOnly><ConfigurationOnly> element can be used to create configuration tasks for data projects. When

ConfigurationOnly is set to Yes, the data projects are only created but not executed. This allows for managing

data projects across environments in an automated manner.



lcsProjectId=''/>
        <DataFile ID='FinancialsPICH' name='Demo data-7.3-200-Financials-PICH' assetType='Data package' 
lcsProjectId=''/>
        <DataFile ID='FinancialsPIFB' name='Demo data-7.3-200-Financials-PIFB' assetType='Data package' 
lcsProjectId=''/>

        <JobDefinition ID='ImportJobDefinition_1'>
            <ConfigurationOnly>Yes</ConfigurationOnly>
            <Operation>Import</Operation>
            <Truncate>No</Truncate>
            <Mode>Import async</Mode>
            <BatchFrequencyInMinutes>1</BatchFrequencyInMinutes>
            <NumberOfTimesToRunBatch >2</NumberOfTimesToRunBatch>
            <UploadFrequencyInSeconds>1</UploadFrequencyInSeconds>
            <TotalNumberOfTimesToUploadFile>1</TotalNumberOfTimesToUploadFile>
            <SupportedDataSourceType>Package</SupportedDataSourceType>
            <ProcessMessagesInOrder>No</ProcessMessagesInOrder>
            <PreventUploadWhenZeroRecords>No</PreventUploadWhenZeroRecords>
            <UseCompanyFromMessage>Yes</UseCompanyFromMessage>
            <LegalEntity>DAT</LegalEntity>
        </JobDefinition>

        <EntitySetup ID='Generic'>
            <Entity name='*'>
                <SourceDataFormatName>Package</SourceDataFormatName>
                <ChangeTracking>No</ChangeTracking>
                <PublishToBYOD>No</PublishToBYOD>
                <DefaultRefreshType>Full push only</DefaultRefreshType>
                <ExcelWorkSheetName></ExcelWorkSheetName>
                <SelectFields>All fields</SelectFields>
                <SetBasedProcessing>No</SetBasedProcessing>
                <FailBatchOnErrorForExecutionUnit>No</FailBatchOnErrorForExecutionUnit>
                <FailBatchOnErrorForLevel>No</FailBatchOnErrorForLevel>
                <FailBatchOnErrorForSequence>No</FailBatchOnErrorForSequence>
                <ParallelProcessing>
                    <Threshold></Threshold>
                    <TaskCount></TaskCount>
                </ParallelProcessing>
            </Entity>
        </EntitySetup>
    </SharedSetup>

    <TestGroup name='Set up import jobs for Financials'>
        <TestCase Title='Set up import job for shared set up data package' ID='3933885' RepeatCount='1' 
TraceParser='off' TimeOut='20'>
            <DataFile RefID='SharedSetup' />
            <JobDefinition RefID='ImportJobDefinition_1' />
            <EntitySetup RefID='Generic' />
        </TestCase>

        <TestCase Title='Set up import job for financials HQUS' ID='3933886' RepeatCount='1' 
TraceParser='off' TimeOut='20'>
            <DataFile RefID='FinancialsHQUS' />
                <JobDefinition RefID='ImportJobDefinition_1'>
                    <LegalEntity>HQUS</LegalEntity>
                </JobDefinition>
                <EntitySetup RefID='Generic' />
        </TestCase>

        <TestCase Title='Set up import job for financials PICH' ID='3933887' RepeatCount='1' 
TraceParser='off' TimeOut='20'>
            <DataFile RefID='FinancialsPICH' />
                <JobDefinition RefID='ImportJobDefinition_1'>
                    <LegalEntity>PICH</LegalEntity>
                </JobDefinition>
                <EntitySetup RefID='Generic' />
        </TestCase>

        <TestCase Title='Set up import job for financials PIFB' ID='3933888' RepeatCount='1' 



TraceParser='off' TimeOut='20'>
            <DataFile RefID='FinancialsPIFB' />
                <JobDefinition RefID='ImportJobDefinition_1'>
                    <LegalEntity>PIFB</LegalEntity>
                </JobDefinition>
                <EntitySetup RefID='Generic' />
        </TestCase>
    </TestGroup>
</TestManifest>

Example 2: Automated setup of demo data

<?xml version='1.0' encoding='utf-8'?>
<TestManifest name='Data management demo data set up'>
    <SharedSetup>
        <DataFile ID='SharedSetup' name='Demo data-7.3-100-System and Shared'  assetType='Data package' 
lcsProjectId=''/>
        <DataFile ID='FinancialsHQUS' name='Demo data-7.3-200-Financials-HQUS' assetType='Data package' 
lcsProjectId=''/>
        <DataFile ID='FinancialsPICH' name='Demo data-7.3-200-Financials-PICH' assetType='Data package' 
lcsProjectId=''/>
        <DataFile ID='FinancialsPIFB' name='Demo data-7.3-200-Financials-PIFB' assetType='Data package' 
lcsProjectId=''/>

        <JobDefinition ID='ImportJobDefinition_1'>
                <Operation>Import</Operation>
                <Truncate></Truncate>
                <Mode>Import async</Mode>
                <BatchFrequencyInMinutes>1</BatchFrequencyInMinutes>
                <NumberOfTimesToRunBatch >2</NumberOfTimesToRunBatch>
                <UploadFrequencyInSeconds>1</UploadFrequencyInSeconds>
                <TotalNumberOfTimesToUploadFile>1</TotalNumberOfTimesToUploadFile>
                <SupportedDataSourceType>Package</SupportedDataSourceType>
                <ProcessMessagesInOrder>No</ProcessMessagesInOrder>
                <PreventUploadWhenZeroRecords>No</PreventUploadWhenZeroRecords>
                <UseCompanyFromMessage>Yes</UseCompanyFromMessage>
                <LegalEntity>DAT</LegalEntity>
        </JobDefinition>

        <EntitySetup ID='Generic'>
            <Entity name='*'>
                <SourceDataFormatName>Package</SourceDataFormatName>
                <ChangeTracking></ChangeTracking>
                <PublishToBYOD></PublishToBYOD>
                <DefaultRefreshType>Full push only</DefaultRefreshType>
                <ExcelWorkSheetName></ExcelWorkSheetName>
                <SelectFields>All fields</SelectFields>
                <SetBasedProcessing></SetBasedProcessing>
                <FailBatchOnErrorForExecutionUnit>No</FailBatchOnErrorForExecutionUnit>
                <FailBatchOnErrorForLevel>No</FailBatchOnErrorForLevel>
                <FailBatchOnErrorForSequence>No</FailBatchOnErrorForSequence>
                <ParallelProcessing>
                    <Threshold></Threshold>
                    <TaskCount></TaskCount>
                </ParallelProcessing>
            </Entity>
        </EntitySetup>
    </SharedSetup>

    <TestGroup name='Set up Financials'>
        <TestCase Title='Import shared set up data package' ID='3933885' RepeatCount='1' TraceParser='off' 

The following manifest shows the setup of demo data for three legal entities when the demo data packages are

stored in the Shared asset library. The difference in this example from the previous example is the actual

execution of the data projects to set up the demo data. This is accomplished by not using the ConfigurationOnly

option or setting it to No to use it for consistency of the manifest.



        <TestCase Title='Import shared set up data package' ID='3933885' RepeatCount='1' TraceParser='off' 
TimeOut='20'>
            <DataFile RefID='SharedSetup' />
            <JobDefinition RefID='ImportJobDefinition_1' />
            <EntitySetup RefID='Generic' />
        </TestCase>

        <TestCase Title='Import financials for HQUS' ID='3933886' RepeatCount='1' TraceParser='off' 
TimeOut='20'>
            <DataFile RefID='FinancialsHQUS' />
            <JobDefinition RefID='ImportJobDefinition_1'>
                <LegalEntity>HQUS</LegalEntity>
            </JobDefinition>
            <EntitySetup RefID='Generic' />
        </TestCase>

        <TestCase Title='Import financials for PICH' ID='3933887' RepeatCount='1' TraceParser='off' 
TimeOut='20'>
            <DataFile RefID='FinancialsPICH' />
            <JobDefinition RefID='ImportJobDefinition_1'>
                <LegalEntity>PICH</LegalEntity>
            </JobDefinition>
            <EntitySetup RefID='Generic' />
        </TestCase>

        <TestCase Title='Import financials for PIFB' ID='3933888' RepeatCount='1' TraceParser='off' 
TimeOut='20'>
            <DataFile RefID='FinancialsPIFB' />
            <JobDefinition RefID='ImportJobDefinition_1'>
                <LegalEntity>PIFB</LegalEntity>
            </JobDefinition>
            <EntitySetup RefID='Generic' />
        </TestCase>
    </TestGroup>
</TestManifest>

NOTENOTE
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Thanks to One Version, new updates are now automatically broadcast, downtime is minimal, and customers

enjoy the benefits of staying current with recent features and fixes without having to go through expensive

upgrades.

Feature management lets customers control when new features are applied. Therefore, as an independent

software vendor (ISV) partner, you can innovate together with Microsoft to take advantage of new features

without having to handle the waiting times that come with long release cycles. When all your customers run on

current versions, you have fewer versions to maintain. You can focus instead on building quality into the

solutions that you provide for your customers.

The process of servicing current versions is also more seamless and safer than it was in earlier versions.

Previously, patching required that individual fixes be combined and merged into a customer environment.

Extensibility allows for deployment of side-by-side solutions that give customers more choices about how they

configure their solutions.

In the One Version model, customer user acceptance testing (UAT) environments and production environments

are updated every month. It's critical that updates not cause issues. However, Microsoft acknowledges that both

technical issues and functional issues may arise when environments are updated.

Technical issues include breaking changes in application programming interfaces (APIs) that customizations

in your solutions use.

Functional issues that customers experience can be caused by the untimely introduction of new features.

Microsoft will put any new functionality that might affect existing processes under feature management. In

this way, customers can control when new functionality is adopted. Therefore, they have time to validate,

document, and train their users about the new features.

Functional issues might also be unintended changes that cause functional regressions.

Prevention of technical and functional issues is difficult and requires close coordination between Microsoft and

you as an ISV partner. The Microsoft goal is that you will adopt practices that resemble Microsoft practices. This

topic explains how you and Microsoft can achieve this goal together. Over the next several months, Microsoft

will release new practices and tools to help you. This topic will be updated as the tools and practices evolve.

This topic includes the following sections:

Servicing customers

Compatibility

Runtime compatibility

Design-time compatibility

Developing new releases

Designing for extensibility

Data upgrade

Feature exposure

Branches and builds

Testing

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/lifecycle-services/oneversion-isv.md


 

 

Servicing customers

Compatibility

Deploying updates

ISV solutions as part of One Version automated deployment

Should I release binaries or source code?

Dynamics 365 Finance and Operations apps run on Microsoft Azure. Therefore, it's a solution that runs as a

service. Microsoft services companies 24/7, either proactively from alerts that report unusual behavior, or from

support tickets that are submitted by customers or their partners. Microsoft has a range of tools to help support

the services that are running. These tools include usage data that is collected from the services. To help

safeguard customer data, Microsoft is also careful about who can access customer systems.

When Microsoft analyzes an issue, it might determine that the issue is related to your ISV solution. Microsoft

reports this type of issue to you, so that you can follow up offline.

Companies can opt out of updates for two consecutive service updates before the next service update is applied

to their environments. Therefore, at any time, Microsoft can expect that companies will be running one of the

last three monthly updates.

When Microsoft resolves an issue that requires a code fix, it generally includes that code fix in the next monthly

update. However, very critical issues that are reported, such as production outage, might require that a fix be

provided for the version that customers are currently running.

Similar policies apply to your ISV solution, and you might also have to provide a code update. For your solution

to be binary-compatible with all your customers, it must be built on the oldest platform release that you want to

support. All new updates that Microsoft releases are intended to be binary backward-compatible. This

compatibility gives you the option of maintaining only one servicing version of your solution that is based on

the oldest of the three most recent updates. Therefore, you must maintain just one released solution,. You can

then use that solution to update all your customers, regardless of which of the three most recent updates they

are running. As your customers adopt new Microsoft updates, you can rebase your maintained solution to a

newer release to remain current with the three most recent updates.

This recommendation applies to servicing and maintaining your released solution. You will use a different

approach to develop new releases of your solution. For more information, see the Developing new releases

section of this topic.

Microsoft diligently tries to guarantee compatibility with existing customizations. To achieve this goal, Microsoft

uses strict practices in its engineering processes, together with tool and automation support that helps identify

API contracts that are unintentionally broken. Telemetry lets Microsoft engineers determine customizations that

reference or extend a Microsoft API.

Updates to Finance and Operations apps that are applied to customer environments are intended to be

functionally compatible and binary-compatible with existing customizations. This compatibility covers not only

APIs, but also functionality and the user experience. Customers must explicitly opt in to all new experiences.

Any deprecation or breaking change in binary or functional compatibility will be announced 12 months in

advance. Therefore, you will have enough time to align your customizations with an alternative design. You must

pay attention to the monthly updates to Microsoft documentation, and you must review the APIs that are

marked as obsolete (deprecated) or internal. In this way, you will be able to manage changes in a timely manner.

The following sections define and describe the aspects of backward compatibility: runtime compatibility and

design-time compatibility.



  

    

  

Runtime compatibilityRuntime compatibility

Design-time compatibilityDesign-time compatibility

Developing new releases

All new updates are intended to be runtime backward-compatible. This compatibility covers both binary

compatibility and functional compatibility. Runtime compatibility means that customizations that exist in

production and sandbox environments will continue to work after new updates are deployed in those

environments. These updates include both service updates and quality updates.

Runtime compatibility also means that changes made by Microsoft to the platform will be backward-compatible

with customizations that were compiled on an earlier platform.

Binary compatibility is backwards only. You can compile a customization on an older platform, and deploy it to a

customer environment that has been updated to a later version. You cannot deploy code compiled on a later

version than the one running on the environment you deploy to.

Design-time backward compatibility (that is, compile-time compatibility) means that developers can apply

updates to their development environments and successfully compile their code without having to make any

changes.

You must be aware of how APIs in your solution are used in your customers' implementations, and how you can

use these APIs without causing breaking changes. As part of this effort, you must pay careful attention to what is

changed and rely on engineering best practices. For examples of changes that you should avoid, see Breaking

changes.

You should try to meet a bar that resembles the bar that Microsoft sets. In that way, both you and Microsoft can

help avoid creating regressions.

All Microsoft updates are intended to be binary (runtime) compatible, and Microsoft also aims for design-time

compatibility. However, there is one category of required changes that is notnot design time–compatible but

remains binary-compatible. After an update is applied, new errors or warnings might occur when your code is

compiled. Here are some examples of these changes:

Microsoft makes an enumeration extensible.

Microsoft marks an API as obsolete or internal.

Microsoft introduces a new compiler error to help avoid unsafe coding practices.

All these changes might require work on your solution.

Design-time breaking changes that are binary-compatible don't require a 12-month deprecation notice.

Together, One Version and the fact that the Finance and Operations apps run as a service provides a great

vehicle for collecting feedback. Feedback is useful, because it helps Microsoft decide which new features it

should add to upcoming updates. Historically, the Microsoft approach has been to release major releases that

include many new features. However, the new model encourages a different approach. Therefore, Microsoft has

moved to a series of continuous updates that gradually build on the available capabilities of the system. In many

cases, one update contains an initial small feature that Microsoft then enriches in later updates. In some cases,

Microsoft must provide staging for new features, and must use feature exposure to hide the new features or

control modifications to them.

We recommend that you follow a similar approach for your ISV solutions. You will benefit from quicker

integration and extension of new standard features.

As the following illustration shows, the frequency of your new releases can be independent of Microsoft

releases. You should consider adopting a strategy for source code branching, as described in the Branches and

builds section of this topic.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/extensibility/breaking-changes


  

  

  

Designing for extensibilityDesigning for extensibility

Data upgradeData upgrade

Feature exposureFeature exposure

What is essential is the quality of every update that is released. Although testing helps guarantee quality, quality

must also be built in during the design and implementation phases. In the One Version model, there are some

new dimensions to consider, as described in the following sections.

To design your solution for extensibility, you must consider now only how you will customize by extending the

standard application, but also how you will enable customization of your ISV solutions by your customers and

partners.

Make sure that customizations are additive instead of intrusive, and follow the guidance on the Extensibility

home page.

Don't be too creative about the way that you build your customization. Otherwise, you might extend an API that

is questionable and increase the risk that later updates will break your solution. Instead, log an extensibility

request, and ask that Microsoft create a more explicit API that is more resilient to breakage.

Design solutions that are extensible. For inspiration, see Write extensible code.

Design for backward compatibility to avoid breaking customer implementations. A good strategy is to be explicit

about what you offer for hooking and wrapping extension code. The way that you decorate your methods gives

you lots of control over which methods you enable extensions for. For more information, see Attributes that

make methods extensible.

The types of data upgrade jobs that existed in earlier versions are no longer supported. This change was made

because Microsoft wants to provide minimum downtime while a production environment is updated.

Database synchronization is still run during upgrade, and it supports basic operations such as adding new

tables, field, and indexes.

To prevent downtime, Microsoft is introducing new ways of driving data upgrade that are run asynchronously.

For example, data upgrade will sometimes be triggered when a feature is turned on through a feature flag. This

new approach for data upgrade differs significantly from earlier approaches and will become available in

upcoming updates. Documentation resources will also be available.

In the One Version model, updates are managed by Microsoft and pushed to customer environments. Pushed

updates should not require that customers adjust to functional changes, or that they train their users about new

or changed features every month. Pushed updates also should not cause customers to delay updates to their

environment.

Feature management is a new concept that puts customers in control of deciding when new or changed features

are used. Customers can review, validate, and document new or changed features before they are adopted. They

can also train users before new or changed processes are adopted, to reduce the impact on daily operations.

Feature management will be released in upcoming monthly updates.

You should consider using feature management with your ISV solution to let customers control when new

features are adopted.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/extensibility/extensibility-home-page
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/extensibility/extensibility-requests
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/extensibility/writing-extensible-code
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/extensibility/extensibility-attributes


  

 

Branches and builds

Servicing branchServicing branch

Development branchDevelopment branch

Testing

Currently released products – Testing binary and functional compatibilityCurrently released products – Testing binary and functional compatibility

As an ISV, you should plan on a minimum of two source code branches: a servicing branch and a development

branch.

The servicing branch is used to produce bug fixes for your ISV solution. As the ISV, you specify the frequency of

releases from the branch and distribution of the releases. The expectation is that these releases from the

servicing branch will be binary cumulative releases.

The base Microsoft version that you use to build your ISV solution should match the oldest version that

customers use with the solution. In the One Version model, that version starts with version 8.1 and is a

maximum of three months old.

The development branch is used to develop new capabilities for the ISV solution. As the ISV, you determine the

frequency of releases from the development branch. You don't have to synchronize your releases with the

monthly Microsoft releases. The best approach might be to decouple your release schedule from the Microsoft

release schedule and deliver releases less often. A quarterly or biannual cadence is a good starting point.

The base Microsoft version in the development branch should be either the latest released version that is

available or the released version that you plan to use for servicing when your new release goes out. The goals

are that you innovate together with Microsoft by staying as current as is feasible, and that your development

model allows for uptake of recent feature work.

Microsoft has several checks and balances in its development process to help guarantee functional and binary

compatibility. ISV solutions must be validated with each Microsoft release to help guarantee this compatibility.

The expectation is that you will do this validation during the Partner Early Access Program (PEAP) phase of each

release.

It's very important that you provide quick turnaround for feedback, so that you will have time to fix any issues

before the monthly updates are deployed in customer environments.

Test automation is important for quick validation of new updates. Microsoft plans to release the test framework

and libraries to support you as you build your test automation.

Microsoft has an extensive suite of tests that support our validation. The expectation is that you, as an ISV, will

create your own suites of automated tests.

In addition to the SysTest automation framework that is aimed at developers, the Regression Suite Automation

Tool (RSAT) enables automation of business processes without requiring that code be written. Functional users

can use the RSAT to record their critical tests and automate part of their UAT. You can also use the RSAT as you

start to build your test automation.

Recently, Microsoft released the Acceptance test library resources and accompanying libraries. This framework is

aimed at developers and lets them build tests that are more comprehensive than unit tests. The libraries that

accompany the framework help make it a seamless way to build suites of tests.

The currently released product that is maintained in the servicing branch should first be tested for binary and

functional compatibility. Your suite of automated developer tests, automated functional tests, and manual tests

for your ISV solution should be run on an environment that has the new version from Microsoft and your

existing ISV solution. Because this test run is testing for binary and functional compatibility, the ISV solution

should notnot be recompiled.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/perf-test/acceptance-test-library


 

Currently released products – Testing design-time compatibilityCurrently released products – Testing design-time compatibility

Currently released products – Updating the base buildCurrently released products – Updating the base build

Solutions that are in developmentSolutions that are in development

Deploying updates

If the testing is successful, this step will validate that a customer installation of the current version of your ISV

solution won't have to be updated when Microsoft broadcasts the new release to the customer.

If the testing isn't successful, you, as the ISV, must immediately notify Microsoft through the PEAP

communication process. This process uses Yammer and an issue notification process. The issue will require

either a fix from Microsoft or a fix in your ISV solution. A fix in your solution might, in turn, require that

customers be updated from the servicing branch. In both cases, Microsoft must know about the issue, so that it

can become more proactive in its processes for future releases.

Next, the currently released product that is maintained in the servicing branch should be tested for design-time

compatibility. To do this testing, you should compile the solution against a deployment of the new Microsoft

release. Although the goal of Microsoft is to minimize design-time compatibility issues, they might occur in

some situations. One example is when Microsoft makes an enumeration extensible, and the solution uses it in a

manner that assumes an underlying integer representation (for example, it uses the enumeration value in a

logical comparison or mathematical function). Although the code will continue to work in a customer

deployment because the underlying values are maintained, a compiler error is generated and addressed in

future releases. Another example of a design-time compatibility issue is when Microsoft introduces a new

compiler error to protect against unsafe coding patterns. To learn about more categories of design-time

compatibility issues, see Breaking changes.

You should run your suite of automated developer tests, automated functional tests, and manual tests on an

environment that has the new version from Microsoft and your compiled ISV solution.

If the testing is successful, this step will validate that your ISV solution won't have to be updated even if source

code is supplied to the customer and the customer recompiles the ISV solution.

If the testing isn't successful, and the issue isn't one of the categories that are described in Breaking changes,

you, as the ISV, must immediately notify Microsoft through the PEAP communication process. This process uses

Yammer and an issue notification process. The issue will require either a fix from Microsoft or a fix in your ISV

solution. A fix in your solution might, it turn, require that customers be updated from the servicing branch. In

both cases, Microsoft must know about the issue, so that it can become more proactive in its processes for

future releases.

As Microsoft updates your customers to new releases, you should periodically update the base build, so that it

matches the oldest version that is used by customers who run your ISV solution.

You validate your new solution development on either the latest released version or the released version that

you plan for to use for servicing when your new release goes out. However, in both cases, consider doing

validation on the most current version. This validation will help with early discovery of issues or uptake work

that you must do.

If an unexpected break occurs, then you, as the ISV, must immediately notify Microsoft through the PEAP

communication process. This process uses Yammer and an issue notification process.

For Microsoft standard platform and application updates, One Version servicing includes a process for

automated updates of customer environments. However, this automation isn't currently available for ISV

solutions. For more information, see ISV's as part of One Version service updates.

ISV solutions are manually updated, and you control your release cadence. The binary backward compatibility

allows for safe updates of the standard platform and application.

https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version#how-can-i-get-early-access-to-non-released-platform-updates
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/extensibility/breaking-changes
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/extensibility/breaking-changes
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version#how-can-i-get-early-access-to-non-released-platform-updates
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version#how-can-i-get-early-access-to-non-released-platform-updates


  

 

ISV solutions as part of One Version automated deployment

Should I release binaries or source code?

NOTENOTE

The update process includes database synchronization (for example, the addition of new fields and indexes).

Although Microsoft doesn't currently plan to release ISV solutions as part of the One Version automated

deployment process, this option might become available at some point. However, Microsoft must first align

engineering processes to make this option feasible.

Here are some areas where alignment will be required:

Feature managementFeature management – The user must be able to control when a new feature is turned on.

Backward compatibility and complianceBackward compatibility and compliance – Compliance with API customization usage is required.

Feature deprecationFeature deprecation – Advanced notice about deprecation of features or APIs must be provided.

Test automation suiteTest automation suite

Testing during the preview phaseTesting during the preview phase

ISV solution sign-off and uploadISV solution sign-off and upload

Automated deployment scr iptsAutomated deployment scr ipts

Zero downtimeZero downtime – Deployment of updates must be instantaneous.

Data migration without downtimeData migration without downtime

Suppor t for on-call duty, for ser vicing of cr itical production issuesSuppor t for on-call duty, for ser vicing of cr itical production issues

Binary compatibility is supported, provided that you don't recompile. We recommend that your ISV solution not

be compiled in customer environments. Instead, you should deploy precompiled binaries that you've prepared

and validated. Your solution binaries can then be created from your servicing branch, based on an earlier

version, when this approach is practical.

If an implementation partner or customer compiles your solution in an updated environment, new warnings

and errors might occur, as was mentioned in the Design-time compatibility section of this topic. Therefore, we

recommend that implementation partners not compile your solution. However, this recommendation doesn't

mean that you shouldn't share your source code to help support debugging, for example. You should just

consider taking steps to avoid compilation of your code, so that implementation partners aren't exposed to

design-time issues.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Create a Scenario Acceptance Testing BPM library

Create a BPM libraryCreate a BPM library

Record test cases and save to BPMRecord test cases and save to BPM

You can use Task recorder and Business process modeler (BPM) to create user acceptance test libraries. Task

recorder is a powerful tool to record test cases and organize them by business process using BPM. As a

Microsoft partner you can use BPM to distribute test libraries to your customers via LCS and LCS solutions. If

you are a customer, use BPM to author and distribute test libraries across different projects and team.

Because BPM can be synchronized with Azure DevOps (formerly known as Visual Studio Team Services), you can

automatically create test cases (including test steps) in your Azure DevOps project. Azure DevOps can then serve

as your test configuration and test management tool where you can create targeted test plans and test suites,

manage the execution of tests and investigate results. For more information about testing with Azure DevOps,

see What are test plans, test suites, and test cases?

This topic walks through the process of creating and executing acceptance test suites to be used for manual or

automated testing.

BPM is a great LCS tool to describe a hierarchy of business processes and user tasks. LCS also allows Microsoft

partners and customers to author and distribute BPM libraries across LCS projects via the Asset library. This

section describes how to take advantage of BPM to define your acceptance test library.

There are several ways to create a Business process modeler (BPM) library. For more information about how to

create libraries in BPM, see Create, edit, and browse Business process modeler (BPM) libraries.

For illustration purposes, this topic uses a library that contains common business processes, such as create an

expense report and approve order requests. The library was created by using the Excel import functionality.

After you have created a BPM library, you'll need to use Task recorder to create your test cases and then upload

the cases to BPM. There are several ways to do this.

If you're using a BPM library that already has all of the necessary task recordings (test cases) attached, you can

skip this step. Otherwise, follow the instructions below to create new task recordings.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/lifecycle-services/using-task-guides-and-bpm-to-create-user-acceptance-tests.md
https://docs.microsoft.com/en-us/azure/devops/test/create-a-test-plan?view=azure-devops#what-are-test-plans-test-suites-and-test-cases
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/creating-editing-browsing


Create and save a new task recordingCreate and save a new task recording

NOTENOTE

Upload an AXTR file to BPMUpload an AXTR file to BPM

1. Open the client and sign in.

2. Select the company that you want to use while recording.

3. Go to SettingsSettings  > Task recorderTask recorder .

4. Click Create a new recordingCreate a new recording.

5. Enter a name for the recording, and then click Star tStar t. Recording begins the moment that you click Star tStar t.

6. When the recording is complete, in the Task recorder pane, click StopStop.

7. To save the task recording to an attached BPM, click Save to L ifecycle Ser vicesSave to L ifecycle Ser vices .

8. Select the library that you want to save the recording to, and then click SaveSave. Otherwise, select Save toSave to

DiskDisk and follow the steps in the next section, "Upload an AXTR file to BPM."

To enable the effective execution of your tests using automation tools, make sure all of your task recordings start on the

main dashboard of your application. For end-to-end processes that are performed by more than one user, we

recommend that you divide your task recordings into user-specific tasks. This simplifies the maintenance of test cases and

allows you to execute test cases in the context of security roles, which is a best a practice.

If you have saved your recordings (AXTR files) to disk, follow these steps to upload them to BPM.

1. In Lifecycle Services (LCS), in your project, on the Business process librar iesBusiness process librar ies  page, select the library to

upload the task recording to.

2. Click Author and editAuthor and edit and in the lines, locate and select the process to upload the task recording to.



Save an existing task recording to BPMSave an existing task recording to BPM

Guidelines for recording test casesGuidelines for recording test cases

3. In the right pane, click UploadUpload.

4. Click BrowseBrowse to find and select the file to upload, and then click UploadUpload.

1. To attach an existing task recording, sign in to the client.

2. Go to SettingsSettings  > Task recorderTask recorder .

3. Select Edit Task RecordingEdit Task Recording and attach the file by either saving directly to LCS or downloading the AXTR and

then uploading to BPM.

Follow these guidelines when authoring and recording your test cases, especially if you are planning to

automate test execution. The process and tools described in this article apply to business process acceptance

tests. They are not meant to replace component and unit testing that is typically owned by developers.

Author a limited number of test cases that, when combined, cover complete end-to-end processes.

Focus on business processes that have been customized.

An individual test case (recording) should cover one or two business tasks only, typically executed by one

person. This simplifies task recording maintenance. Do not combine a complete end-to-end business process

such as "Procure to Pay" or "Order to Cash" into one large task recording. For example, instead of having

RFQ > Purchase Order > Product Receipt > Vendor Invoice > Vendor Payment as one test case, divide the

process into three or four test cases. You will have the opportunity to combine these tests into an ordered



Synchronize and configure your test plan in Azure DevOps

Sync with Azure DevOpsSync with Azure DevOps

test suite later.

A test case should have at least one validation. Try to validate critical fields that cover the impact of other

fields. For example: Validation of totals on sales or purchase orders cover the unit price/quantity/discount/tax

...etc.

Avoid printing a report in a test case. If a test case needs to print a report, it should be selected on screen.

80+% of test cases should be of transactions or source documents. Master data should be limited to up to

20% of test cases only.

An acceptance test library is your starting point. It typically contains all test cases (task recordings) of a

particular application organized by business process. During a particular test pass, you usually do not need to

execute all test cases. What test cases you select depends on the phase of your implementation or the nature of

the update you are planning to apply to your production environment. Azure DevOps enables you to organize

your test cases in test plans and test suites. A test plan contains one or more test suites (A subset of your test

library); test cases can belong to more than one test suite.

Once you have selected your acceptance testing BPM library, synchronize it with Azure DevOps and create your

test plan and test suites.

Synchronize your BPM library with your Azure DevOps project. For more information, see Synchronize BPM

libraries with Azure DevOps.

After configuration is complete, synchronize the BPM library with a Azure DevOps project.

1. On the Business process librar iesBusiness process librar ies  page, on the tile for the library that you want to synchronize, select

the ellipsis button (…), and then select Azure DevOps syncAzure DevOps sync.

You can also start Azure DevOps synchronization from the toolbar in a BPM library. Select the ellipsis

button (…), and then select Azure DevOps syncAzure DevOps sync.

2. After Azure DevOps synchronization is complete, select the ellipsis button (…), and then select Sync testSync test

casescases .

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/synchronize-bpm-vsts


Create a test suite in Azure DevOpsCreate a test suite in Azure DevOps

3. When this step is complete, your task recordings will become test cases in Azure DevOps and a link will

appear under the RequirementsRequirements  tab.

In addition to the test steps, the task recording XML file is attached to the Azure DevOps test case. This file will

be needed if you want to automate test execution.

Next, you will need to create a test plan and test suite in Azure DevOps. This will allow you to execute an ordered

suite of test cases and easily manage, investigate, and track the results.

1. Sign in to Azure DevOps and select the project and test plan that you want to test in.

2. On the toolbar, select TestTest > Test PlansTest Plans .

3. In the left pane, select ++, and then select Static suiteStatic suite.

4. Enter a name for the suite.

5. Click Add existingAdd existing and query the tag LCS:Test CasesLCS:Test Cases .

6. Click RunRun > Add test casesAdd test cases .



NOTENOTE

Execute your tests
Run manual test casesRun manual test cases

7. Select the test case to view details and the attached XML file.

This example shows how to create one comprehensive acceptance test suite with all test cases added. Instead, you should

create various test suites under the same test plan and then use custom queries to add specific test cases to a test suite.

A test case can belong to more than one test suite.

After you have a test suite, you are ready to use it for regression testing after updates have been made to your

application in a sandbox or test environment. You can run the test cases in your test suite manually or play the

task recordings that are part of the test suite and use Azure DevOps to mark the test cases as passed or failed.



Run automated test casesRun automated test cases

Investigate test runsInvestigate test runs

NOTENOTE

Azure DevOps also provides a tool, Test RunnerTest Runner , to manage manual test case execution. For more information

about using Test Runner, see Run manual tests.

We recommend that you take advantage of Azure DevOps as it provides a rich set of management features not

only for testing, but result management and mitigation.

The platform for Finance and Operations provides developers with tools to author test cases based on task

recordings and use Azure DevOps to manage the automated execution of these test cases.

Developers can use the build and test automation capabilities of build and testbuild and test environments. For details, see

the Continuous delivery home page.

Functional power users can automate the execution of their test cases using the Regression suite automationRegression suite automation

tooltool . For more information, download the tool and read the Regression suite automation tool.

Once an automated run is complete, on the Azure DevOps toolbar, select Test > RunsTest > Runs  (or Test Plans > RunsTest Plans > Runs )

to investigate your test run. Select the desired test run to investigate test case failures and errors. You can also

go to your test suite in Azure DevOps to see the latest results associated with your test cases. For more

information on testing and test management in Azure DevOps, see the Azure DevOps documentation.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/vsts/manual-test/getting-started/run-manual-tests
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-tools/continuous-delivery-home-page
https://www.microsoft.com/download/details.aspx?id=57357
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/perf-test/rsat/rsat-overview
https://docs.microsoft.com/en-us/azure/devops
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Prerequisites

Deploy a demo environment

This topic explains how to deploy a demo environment on Microsoft Azure using Microsoft Dynamics Lifecycle

Services (LCS). This topic applies to deploying a demo environment for :

Dynamics 365 Finance

Dynamics 365 Supply Chain Management

Dynamics 365 Commerce

Before you begin your deployment, the following prerequisites must be in place:

Verify that you have an Azure subscription, and that you are a co-administrator on it.

Verify that you have access to an LCS project and permissions to deploy an environment.

Verify that you’ve connected your Azure subscription to your LCS project by using the information in the

Complete the Azure Resource Manager (ARM) onboarding process topic.

Use this procedure to deploy a demo environment on Azure using LCS.

NOTENOTE

1. In LCS, open your project, and then, in the EnvironmentsEnvironments  section, click the plus sign (++).

2. Select the Azure environment topology, and then select DemoDemo.

3. Select a topology.

For Finance and Operations, select the most recent Azure Resource Manager (ARM) topology for

Finance and Operations.

For Commerce, select Dynamics 365 for Commerce - DemoDynamics 365 for Commerce - Demo.

4. In the Deploy environmentDeploy environment dialog box, enter the name of the environment. This name should be

unique in the Azure subscription. To make environments easy to identify, consider forming an acronym

using the user ’s name and the topology.

5. Select the size of the virtual machine (VM). You must use Ev3-ser ies sizesEv3-ser ies sizes  for Finance and Operations

workloads. We recommend Ev3Ev3 . If you experience allocation failures, see the Azure troubleshooting

guide.

6. Set the InstancesInstances  field to 1.

The size of the VM and the number of instances affect the cost of your subscription. For more information, see

Azure pricing.

7. Click Advanced settingsAdvanced settings  to add customizations to your deployment. For the demo environment, we

recommend that you keep the default settings.

8. Agree to the licensing and pricing terms, and then click NextNext.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/deployment/deploy-demo-environment.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/arm-onboarding
https://docs.microsoft.com/en-us/azure/virtual-machines/troubleshooting/allocation-failure
https://azure.microsoft.com/pricing/


Log on to your demo environment

NOTENOTE

9. In the ConfirmConfirm message box, click DeployDeploy .

10. Open the Cloud hosted environmentsCloud hosted environments  page to view the status of the deployment. After the

deployment is successfully completed, the environment will be ready.

To log on to your demo environment, do the following.

1. In LCS, open the Cloud-hosted environmentsCloud-hosted environments  page, and select the demo environment that you just

deployed.

2. Scroll to the right and in the Environment detailsEnvironment details  pane, under Cloud ser vicesCloud ser vices , click the appropriate

link:

Log on to Finance and OperationsLog on to Finance and Operations

Log on to CommerceLog on to Commerce

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

Why cloud

Why on-premises

You can deploy Finance and Operations apps in the cloud or on-premises. Cloud deployments offer an ERP

service that is fully managed by Microsoft, while on-premises deployments are deployed locally within a

customer's data center.

On-premises deployments are not supported on any public cloud infrastructure, including Azure.

The following table provides a comparison of the capabilities provided by the two deployment options.

Cloud deployments provide a cloud service that is easy to scale up or down as needed, as well as data centers

that are fully managed by Microsoft. The time spent implementing Finance and Operations apps can be

significantly shortened, fewer customizations may be required, and the costs of IT hardware and infrastructure

are lower.

Cloud deployments include high availability, disaster recovery, sandbox environments, and application lifecycle

management combined with cloud-based systems of intelligence, infrastructure, compute, and database

services in a single offering. When needed, data failover in the cloud, automated deployment and continuous

updates, and elastic compute capacity are available. A cloud deployment also provides data aggregation,

financial reporting, and intelligence.

The cloud service provides customers with the greatest value, the broadest range of functionality, the best

application lifecycle experience, the easiest and broadest integration with Microsoft Azure services, the best

option for business insights and intelligence, and the most value for customers’ technology investments.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/deployment/choose-deployment-type.md
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/deployment/media/deployment-options.png


NOTENOTE

With an on-premises deployment, existing data center investments can be leveraged. Customers can also

configure their enterprise preferences to meet the regulatory and compliance needs of their business, comply

with data sovereignty rules in regions where there are no Azure Data Centers, or ensure business continuity in

areas with limited public infrastructure.

A customer’s business data and processes are disconnected from the cloud and are stored and run locally in the

customer’s or their partner ’s data center. Some connectivity is required for system management and updates

which are enabled through Microsoft Dynamics Lifecycle Services (LCS), a cloud-based application lifecycle

management service. Customer data that is related to the configuration and application customization may be

stored in the cloud.

For customers who choose to run Finance and Operations apps in their own data center, the on-premises

deployment option will have a similar user-interface and application functionality as other deployment options.

However, customers must take on the following responsibilities:

Stand up their own infrastructure.

Configure their own high-availability and disaster recovery solutions.

Stand up sandbox environments.

Manage their infrastructure, including scheduling operating system updates.

The additional costs to deploy and manage these capabilities might lead to higher deployment costs and a

greater Total Cost of Ownership (TCO). Tools for deploying the Finance and Operations apps and updates will be

available to partners and customers via Lifecycle Services. Unlike the cloud deployment option, Advanced

Analytics and Azure Machine Learning are not included in the on-premises deployment option.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Dynamics 365 Finance

A REAA REA F EAT UREF EAT URE C LO UDC LO UD O N - P REM ISESO N - P REM ISES

Compliance and
certifications

Yes Yes

SOC 1 Type 1 certification Yes No

Data management and
integration

Yes Yes

Export data to your own
data warehouse

Yes Yes

Enable the export of
incremental updates to a
data entity

Yes Yes

Data integrations Yes Yes

Document management Yes Yes

Financial management Yes Yes

Help Yes No

Human resources Yes Yes

Intelligence Yes Yes

Electronic reporting (ER) Yes Yes

ER: Integration with LCS Yes No

This topic shows a comparison of features available in cloud vs. on-premises for the following applications:

Dynamics 365 Finance

Dynamics 365 Supply Chain Management

Dynamics 365 Commerce

Dynamics 365 Human Resources

Information about the development and administration features is included, as well.

The following tables list the application areas. Cloud and on-premises support is listed for the feature as a

whole. Where specific features differ from the area overall, the features are listed on a separate line in the

Feature column.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/cloud-prem-comparison.md


ER: Integration with
SharePoint

Yes No

ER: Integration with
Regulatory Configuration
Services (RCS)

Yes No

ER: Uses local file system as
storage of ER configurations
accessible via ER
repositories

No Yes

Integration with
PowerBI.com

Yes No

Integration with PowerBI
Desktop

No Yes

Analytical workspaces Yes No

Intelligent business process:
Recommendations

Yes No

Authoring Power BI reports
with OData using Power BI
desktop or Excel
PowerQuery tools

Yes No

SQL Server Reporting
Services (SSRS) supports
scaling out

Yes No

Telemetry is transferred into
the cloud

Yes No

Lifecycle services Yes Yes

Configurable business
processes

Yes No

Localizations Yes Yes

Mobile app, workspaces,
and platform

Yes Yes

Office integration Yes Yes

Organization administration Yes Yes

Payroll Yes Yes

Direct deposit Yes No

A REAA REA F EAT UREF EAT URE C LO UDC LO UD O N - P REM ISESO N - P REM ISES



 

Project management and
accounting

Yes Yes

Security Yes Yes

Service management Yes Yes

Web client Yes Yes

Task recorder - Save or load
task recordings from the
BPM library

Yes No

Support Yes Yes

Access to Support via the
Help & Support menu

Yes No

Business events Yes Yes (either internet
connectivity is required or
custom endpoints must be
implemented to
send/receive business
events within intranet)

A REAA REA F EAT UREF EAT URE C LO UDC LO UD O N - P REM ISESO N - P REM ISES

Dynamics 365 Supply Chain Management

A REAA REA F EAT UREF EAT URE C LO UDC LO UD O N - P REM ISESO N - P REM ISES

Asset management Yes No

Compliance and
certifications

Yes Yes

SOC 1 Type 1 certification Yes No

Cost accounting Yes Yes

Cost accounting content
pack for Power BI

Yes No

Cost accounting workspace
for mobile app

Yes No

Cost management Yes Yes

Cost management content
pack for Power BI

Yes No

Data management and
integration

Yes Yes



Configuration-driven
extension

Yes No

Export data to your own
data warehouse

Yes Yes

Enable the export of
incremental updates to a
data entity

Yes Yes

Data integrations Yes Yes

Document management Yes Yes

Help Yes No

Intelligence Yes Yes

Electronic reporting (ER) Yes Yes

ER: Integration with LCS Yes No

ER: Integration with
SharePoint

Yes No

ER: Integration with
Regulatory Configuration
Services (RCS)

Yes No

ER: Uses local file system as
storage of ER configurations
accessible via ER
repositories

No Yes

Integration with
PowerBI.com

Yes No

Integration with PowerBI
Desktop

No Yes

Analytical workspaces Yes No

Intelligent business process:
Recommendations

Yes No

Authoring Power BI reports
with OData using Power BI
desktop or Excel
PowerQuery tools

Yes No

SQL Server Reporting
Services (SSRS) supports
scaling out

Yes No

A REAA REA F EAT UREF EAT URE C LO UDC LO UD O N - P REM ISESO N - P REM ISES



Telemetry is transferred into
the cloud

Yes No

Inventory management Yes Yes

Lifecycle services Yes Yes

Configurable business
processes

Yes No

Localizations Yes Yes

Manufacturing Yes Yes

Master planning and
forecasting

Yes Yes

Planning optimization Yes No

Mobile app, workspaces,
and platform

Yes Yes

Office integration Yes Yes

Organization administration Yes Yes

Procurement and sourcing Yes Yes

Punch-out to external
catalog from purchase
requisition

Yes No

Purchase spend analysis
Power BI reports

Yes No

Product information
management

Yes Yes

Product master data Yes Yes

Production Yes Yes

Production performance
Power BI reports

Yes No

Project management and
accounting

Yes Yes

Sales Yes Yes

A REAA REA F EAT UREF EAT URE C LO UDC LO UD O N - P REM ISESO N - P REM ISES



 

 

 

Sales and profitability
performance Power BI
reports

Yes No

Security Yes Yes

Service management Yes Yes

Supply chain management Yes Yes

Transportation
management

Yes Yes

Vendor collaboration Yes No

Warehouse management Yes Yes

Mobile warehouse app Yes Yes

Warehousing Power BI
reports

Yes No

Web client Yes Yes

Task recorder - Save or load
task recordings from the
BPM library

Yes No

Support Yes Yes

Access to Support via the
Help & Support menu

Yes No

A REAA REA F EAT UREF EAT URE C LO UDC LO UD O N - P REM ISESO N - P REM ISES

Dynamics 365 Commerce

Dynamics 365 Human Resources

A REAA REA F EAT UREF EAT URE C LO UDC LO UD O N - P REM ISESO N - P REM ISES

All Human Resources areas All Human Resources
features

Yes No

Development and administration features

A REAA REA F EAT UREF EAT URE C LO UDC LO UD O N - P REM ISESO N - P REM ISES

Build and test Yes Yes

To see a list of capabilities that are available in on-premises deployments, see Commerce capabilities that are

available in on-premises deployments.

file:///T:/eiye/ac1a/dynamics365/retail/retail-onprem.html


Extensibility Yes Yes

Monitoring and telemetry Yes Yes

Platform compatibility Yes Yes

Servicing Yes Yes

Servicing environments Yes No

Trace Parser Yes Yes

PerfTimer Yes Yes*

Upgrade Yes Yes

Upgrade Yes No

Upgrade and support for
previous versions

Yes No

Visual Studio development Yes Yes

A REAA REA F EAT UREF EAT URE C LO UDC LO UD O N - P REM ISESO N - P REM ISES

NOTENOTE

* In on-premises environments, PerfTimer only shows results for the client.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Customer lifecycle, subscriptions, and environment types
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Evaluation and
analysis

Tier 1 Sandbox Cloud hosted Customer Managed Demo

Working with Microsoft to deploy Finance and Operations apps in the cloud requires that you understand the

environment and subscription that you are deploying to, who can perform which tasks, and the data and

customizations that you need to manage. We recommend that you sign up for the Full Microsoft FastTrack for

Dynamics 365 to help speed your deployment and implementation - it's a program that provides training and

consulting to help you realize business value faster. For more information, see Microsoft FastTrack. If you choose

to use the Essentials FastTrack program instead, you will be using the Implementation Project Methodology in

Lifecycle Services (LCS) to help you manage your implementation project.

Microsoft assumes that all customers will follow a lifecycle similar to the following for all cloud deployments,

and therefore need different environment topologies at each phase.

Evaluate

Develop customizations, if needed.

Curate a "golden configuration" environment that contains only module configurations without master or

transactional data. This is to be the baseline for your data migration testing and eventual go live.

Install and test customizations and partner solutions on a tier-1 sandbox (Development or test environment).

Test customizations, partner solutions and data configuration on a tier-2 sandbox environment.

Deploy customizations and data configurations to a production environment with high availability.

At some phases of a project, you may have all of the environments live at once. For more information, about the

default licenses and tiers that are available, see the Dynamics 365 Licensing Guide.

You may notice the terms cloud hosted or Microsoft subscriptions. A cloud hosted subscription means that the

customer or partner brings their own Azure subscription and deploys Finance and Operations apps to it, for

evaluation and development purposes only. The customer or partner pays for the resources deployed to their

Azure subscription based on the Azure price list. A Microsoft subscription means that the customer purchases

Finance and Operations licenses, which will then allow them to deploy environments to an Azure subscription

which is managed by Microsoft, therefore, the customer has no separate Azure billing.

With each Enterprise offer, two environments are included by default:

One Tier 2 sandbox (multi-box environment) for user acceptance testing (UAT).

One production environment with high availability (HA).

Additional environments may be purchased as add-ons. For information about licensing and what is included in

Microsoft Dynamics 365, see the Dynamics 365 Licensing Guide.

Here's how the lifecycle maps to the available environments. If you already have environments deployed in your

Lifecycle Services project, you can find the Environment Type and Environment Sub type on each environment's

details page.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/deployment/cloud-deployment-overview.md
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/fasttrack-dynamics-365-overview.html
https://go.microsoft.com/fwlink/?LinkId=866544&clcid=0x409
https://go.microsoft.com/fwlink/?LinkId=866544&clcid=0x409


Customize Tier 1 Sandbox Cloud hosted or VHD Customer Managed Develop

Golden configuration Tier 1 Sandbox Cloud hosted Customer Managed Develop

User acceptance
testing (UAT)

Tiers 2-5 Sandbox Microsoft Microsoft Managed
or Self-service

Not applicable

Go live Production Microsoft Microsoft Managed
or Self-service

Not applicable
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Environment lifecycle operationsEnvironment lifecycle operations
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Apply software Install Microsoft updates, ISV
solutions, or your own customization
packages.

Apply updates to cloud environments

Enable access Allow list your IP for Remote Desktop
or database access

See the Remote Desktop section later
in this topic

Restart services Ability to restart components of your
environment

Restart environment services

Move database Full data lifecycle management Database movement operations

Maintenance mode Ability to change configuration with
only admin access

Maintenance mode

Upgrade Upgrade code and data from 7.x to the
latest version

Process for moving to the latest
update

Deallocate Ability to turn off an environment not
being used, or to troubleshoot a failed
action

Not applicable

Start Ability to turn on an environment for
use

Not applicable

Delete Ability to delete an environment
previously deallocated

Not applicable

Security and compliance

Tiers 2-5 can be purchased to increase performance of the environment. The higher the tier, the more compute

and database capacity is reserved for your use. For more information about Self-service environment types,

check out the Self-service deployment overview.

Users with the Environment Administrator or Project Owner roles in Lifecycle Services can perform various

lifecycle operations on their environments. These operations often involve downtime on the environment until

the task is finished. Each of these operations are located under or next to the MaintainMaintain button on each

environment details page.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/infrastructure-stack
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/restart-environment-services
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/database/dbmovement-operations
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/sysadmin/maintenance-mode
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/migration-upgrade/upgrade-latest-update
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Remote Desktop
Microsoft-managed environmentsMicrosoft-managed environments

WARNINGWARNING

Finance and Operations is PA-DSS 3.1 certified which means that all communications between components are

secured out-of-the-box.

All Finance and Operations front-end virtual machines in Microsoft Azure are configured during deployment to

only accept TLS 1.2.

Customers who have administrator access to Microsoft-managed sandboxes, including any add-on sandboxes purchased,

must follow these guidelines:

By default, automatic Windows update is enabled for all Tier 1 - 5 sandboxes and should NOT be disabled. This ensures

that any time that Microsoft pushes security or critical infrastructure updates to your environment, your environment

receives the latest set of updates and is updated each month with the operating system fixes that Microsoft releases.

Admin passwords on these environments should NOT be changed. Environments that have admin passwords changed

will be flagged by Microsoft. Microsoft reserves the right to, and will reset the admin password.

Adding new user accounts to any Microsoft managed VM is NOT permitted. Microsoft reserves the right to, and will

remove the newly added user accounts without providing notice.

Finance and Operations is not covered by a FedRAMP ATO at this time. If Finance and Operations is

provisioned in the United States, all customer data at rest is stored in data centers located in the United

States, as described in International availability of Dynamics 365. Finance and Operations does not support

any other Dynamics 365 US Government or Microsoft 365 GCC compliance attributes (for example, access

by US screened personnel, and support for CJIS and IRS 1075).

Microsoft will be removing the use of Remote Desktop by customers and partners. Each environment will first have

administrator access removed, but still allow non-administrator access to the virtual machines. After this, all access will be

removed. For each step of this phased removal, an email notification will be sent to the Notification list setup for each

environment. All Remote Desktop access will be removed by November 2020.

Customers are required to complete additional setup to connect to virtual machines (VMs) through Microsoft

Remote Desktop (RDP). This additional setup applies to all Microsoft-managed environments, including Tier 1

through Tier 5 sandboxes and add-ons. In order to connect to Tier 1 through Tier 5 sandbox environments, you

must explicitly enable access (safe list) from your organization’s IP address space. This can be done by a Lifecycle

Services (LCS) user who has access to the EnvironmentEnvironment page (MaintainMaintain > Enable AccessEnable Access ) where they can

enter the IP address space that will be used to connect to the virtual machines through Remote Desktop. Access

rules are either a single IP address (example: 10.10.10.10) or an IP address range (example: 192.168.1.0/24). You

may add multiple entries at once as a semi-colon(;) separated list (example:

10.10.10.10;20.20.20.20;192.168.1.0/24). These entries are used to configure the Azure Network Security Group

that is associated with your environment’s virtual network. For more information, see Security rules.

https://www.microsoft.com/trustcenter/privacy/dynamics365-finance-operations
https://docs.microsoft.com/en-us/azure/virtual-network/security-overview#security-rules
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Partner/Customer managed environmentsPartner/Customer managed environments

Windows Remoting (WinRM)

WARNINGWARNING

Availability

High-availability featuresHigh-availability features

Disaster recovery featuresDisaster recovery features

Customers need to ensure that RDP endpoints are secured through explicit IP safe list rules as mentioned above. The IP

safe list rules must adhere to the following conditions.

IP safe list rules must NOT use asterisk/zero.

Wide IP address ranges must NOT be used.

IP address ranges must restrict to the customer's CORPNET.

If computers outside the customer's CORPNET (such as a home office) are used to connect to sandbox environments,

only the specific IP addresses of the computers used to connect to the sandbox environments must be added.

Azure Datacenter IP address ranges must NOT be added.

Public IP addresses, such as a coffee shop location, must NOT be added.

IP safe list rules should be removed when not in use. Periodic review of environment IP safe list rules is recommended.

Microsoft will run periodic tests on the Microsoft Managed environments validating that the environments

are sufficiently restricted. Microsoft reserves the right to and will remove any IP Address safe list rules that

violate the above guidelines, immediately without providing notice.

By default, Remote Desktop is enabled for all non-Microsoft managed environments. We recommend that

customers restrict access to any environments that belong to their subscriptions. This can be done by

configuring Network Security Group rules on the environments directly in Azure Portal.

Windows Remoting (WinRM) is disabled on all environments. Although you can enable WinRM on

environments that belong to your subscriptions through Azure Portal, we strongly recommend that you do not

do this.

Exceptions to enable WinRM will not be granted for any Microsoft-managed environments.

The guaranteed uptime for Finance and Operations apps is 99.9%. Planned downtime occurs once a month and

lasts no longer than eight hours. Because the work completed during the downtime doesn’t always take eight

hours, we will always communicate the estimated amount of time that your environments will be down. For

more information, see Get support for Finance and Operations apps or Lifecycle Services (LCS).

To ensure service availability, all production environments are protected by using default Azure high availability

(HA) features. HA functionality provides ways to avoid downtime caused by the failure of a single node within a

datacenter, and DR features protect against outages broadly impacting an entire datacenter. Azure availability

sets are used to prevent single-point-of-failure events. For more information about Azure availability sets, see

Use availability zones to protect from datacenter level failures. High availability for databases is supported

through Azure SQL. For more information, see Overview of business continuity with Azure SQL Database.

Production environments are configured with Azure disaster recovery support that includes the following:

Azure SQL active-geo replication is configured for the Finance and Operations database of the production

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/lcs-support
https://docs.microsoft.com/en-us/azure/virtual-machines/windows/manage-availability#use-availability-zones-to-protect-from-datacenter-level-failures
https://docs.microsoft.com/en-us/azure/azure-sql/database/business-continuity-high-availability-disaster-recover-hadr-overview


Service availability in Azure Regions

IMPORTANTIMPORTANT

Upcoming changes to region availabilityUpcoming changes to region availability

NOTENOTE

environment. For more information about SQL replication, see Compare geo-replication with failover groups.

Geo-redundant copies of Azure blob storage (containing document attachments) in other Azure regions. For

more information, see Azure Storage redundancy.

Same secondary region for the Azure SQL and Azure blog storage replication.

Only primary data stores are supported by replication. The Financial reporting services and Entity store

database use transformed data from the primary database and must be generated after the recovery site has

been set up and the Finance and Operations service has started.

Finance and Operations apps can be deployed into a subset of Microsoft Azure datacenters using Dynamics

Lifecycle Services (LCS). Azure is generally available in datacenters and geographical locations around the world.

With Finance and Operations apps, customers can specify the region or datacenter where their customer data

will be stored. Microsoft may replicate data to other regions for data durability, but we will not replicate or move

customer data outside the geographical location. For more details, see the Service description white paper.

Regardless of where customer data is stored, Microsoft does not control or limit the locations from which customers or

their end-users may access it. For more information, see International availability of Dynamics 365.

Dynamics 365 solutions consist of a collection of multiple services. Looking across Dynamics 365 applications,

the Power Platform and the Azure services that they both depend on, the required matrix of services is quite

large and growing. We have locked on a strategy of selecting a subset of data center regions across the globe to

simplify ensuring that we have availability of the full portfolio of required services. Our plan is to optimize to

have minimal latency between the component services of a solution and as a result, we are focused on having

the full portfolio of services available in each of the designated data centers.

Additionally, the Finance and Operations architecture is being enhanced to build on self-service for greater

elasticity, stronger reliability, and more seamless maintenance. Customers gain material efficiency by having

deeper self-service deployments in fewer data centers. This transition also benefits from selecting a subset of

Azure regions. To that effect, the regional availability of Finance and Operations apps will now be limited tolimited to

East US, West US, and Central US in Nor th America East US, West US, and Central US in Nor th America for all new projects. For a list of the latest supported

regions, see International availability of Dynamics 365.

Support for East US2, West US2, West Central US, North Central US, and South Central US will continue to be

available for projects and environments that currently have their data stored in those regions on Microsoft-

managed environments.

Microsoft will work with customers to move them to an appropriate data center beginning October 19, 2020. This will

happen in a phased approach. Select customers will receive advance notification before we migrate them to a supported

region.

If there are other customer workloads that are not part of the Dynamics 365 or Power Platform family that also

require proximity to the Dynamics 365 and Power Platform services, Microsoft will work with customers to

coordinate a plan for the overall migration. For more information, see Cloud deployment overview: Frequently

asked questions.

https://docs.microsoft.com/en-us/azure/azure-sql/database/business-continuity-high-availability-disaster-recover-hadr-overview#compare-geo-replication-with-failover-groups
https://docs.microsoft.com/en-us/azure/storage/common/storage-redundancy
https://aka.ms/D365-Cloud-Service-Operations
https://www.microsoft.com/trustcenter/privacy/dynamics365-operations-location
https://www.microsoft.com/trustcenter/privacy/dynamics365-operations-location


 Frequently asked questions
Why does the status display 'Maintenance' on my environment in LCS?Why does the status display 'Maintenance' on my environment in LCS?

How do I connect to the SQL database on my Sandbox environment?How do I connect to the SQL database on my Sandbox environment?

How do I access a development instance?How do I access a development instance?

How do I deploy a demo environment?How do I deploy a demo environment?

How do I move my customizations between environments?How do I move my customizations between environments?

Can I bring my own domain name?Can I bring my own domain name?

Can I add guest AAD accounts as users?Can I add guest AAD accounts as users?

Why am I no longer able to see the Private AOS machines in one or more of my Tier 2 through Tier 5Why am I no longer able to see the Private AOS machines in one or more of my Tier 2 through Tier 5
Sandbox environments?Sandbox environments?

Why am I no longer able to Remote Desktop into one or more of my Tier 1 through Tier 5 MicrosoftWhy am I no longer able to Remote Desktop into one or more of my Tier 1 through Tier 5 Microsoft
managed Sandbox environments?managed Sandbox environments?

To provide the best experience and performance, Microsoft performs maintenance operations on your

environment. During some of these maintenance operations, your environment status may display one of the

following statuses:

Preparing for maintenance

Prepared for maintenance

Maintenance in progress

While your environment is in this state and until the status returns to 'Deployed', you will not be able to perform

any lifecycle operations, such as package applications. There will be no impact to Finance and Operations apps.

Users can continue with normal operations without any service interruption. You will receive an email

notification before any maintenance operation puts your environment in this state.

To connect to the SQL database in your Sandbox environment, follow the steps in Enable just-in-time access.

For information about how to access development instances, configure on-premises development VMs, and find

configurations settings for developers and administrators, see Deploy and access development environments.

A demo environment includes only Microsoft demo data. You can use a demo environment to explore default

features and functionality. For more information, see Deploy a demo environment.

To move customizations from a development to a sandbox or production environment, see Create deployable

packages of models

You can bring your own domain name if it is running Azure Active Directory (AAD), and the administrator of

your AAD instance has enabled the Finance and Operations apps within their AAD. This is usually done through

the office email, after you buy a license. When you click the link to accept the offer, AAD is set up for you.

You can add guest AAD accounts if you have correctly configured them within Azure Active Directory, and

enabled the Finance and Operations apps within your AAD.

The Private AOS VMs were part of your environment configuration as they were needed to secure

communication between the AOS and BI machines in the past. With recent updates, all communication between

AOS and BI machines are secure directly and no longer need the intermediary Private AOS machines. Therefore,

we are in the process of rolling out removing the Private AOS machines. As we are removing the machines in

batches, you may notice that only some of your environments have the Private AOS machines removed. This

change will not impact functionality or security in any way and will be transparent to you.

Microsoft managed Tier 1 through Tier 5 sandbox environments require Remote Desktop management

endpoints to be restricted to specific IP Address sets (safe list). Microsoft regularly validates that the

environments are sufficiently restricted. Microsoft reserves the right to immediately remove any IP Address safe

list rules that violate the above guidelines without notice. You may not be able to Remote Desktop into your

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/database/database-just-in-time-jit-access
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-tools/access-instances
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/create-apply-deployable-package


When will the availability of reduced regions go into effect for new onboarding?When will the availability of reduced regions go into effect for new onboarding?

My environments are currently in the regions that will be deprecated. How will this change affect me?My environments are currently in the regions that will be deprecated. How will this change affect me?

I'm unable to redeploy an environment after deleting it, the environment slot is missing.I'm unable to redeploy an environment after deleting it, the environment slot is missing.

NOTENOTE

environment for one of these reasons:

Your current IP address is not in the safe list.

Your IP has changed from the IP address listed in the safe list.

Microsoft deleted the rule containing your IP address from the safe list because it violated a guideline.

To regain access to the environment, you will need to add the IP address of the computer from which you are

connecting to. To do this, complete the steps Remote Desktop section earlier in this topic.

Beginning August 1, 2020, new projects for Finance and Operations will be onboarded to the following regions:

East US

West US

Central US

We will deprecate support for the following regions only for new projects that will be onboarded on or after

August 1, 2020:

East US2

West US2

West Central US

North Central US

South Central US

This will not affect any environments that have their data stored in the deprecated regions before August 2020.

In the near future there is a transition plan to move customers in the deprecated regions into the reduced

regions.

This is due to the license expiring, which means that you no longer have the minimum required licenses to

obtain an environment slot. Please review your subscription status and then reactivate the expired license to

enable the redeployment.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/subscription-overview#how-can-i-find-the-subscription-status
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Supported web browsers

NOTENOTE

NOTENOTE

Network requirements

This topic lists the system requirements for the current version of Dynamics 365 Finance and Dynamics 365

Supply Chain Management for cloud deployments. If this step is appropriate, before you install one of these

apps, you should verify that the system that you're working with meets or exceeds the minimum network,

hardware, and software requirements.

Users can access the apps by using the most recent versions of these popular browsers:

Microsoft Edge (recommended: Chromium-based Edge)

Google Chrome

Apple Safari

Internet Explorer 11 (deprecated, not recommended)

For optimal performance and an optimal experience, we recommend that you use the latest version of a modern browser,

especially Microsoft Edge. Support for Internet Explorer 11 is deprecated. For more information, see the Internet Explorer

deprecation announcement.

To find the latest release for each web browser, go to the software manufacturer's website.

To enable Task Recorder to capture screenshots and include them in Microsoft Word documents that are generated,

you must install a pre-release Chrome extension.

The Workflow Editor and Report Designer for Financial reporting are started as ClickOnce applications. They require a

64-bit-compatible operating system. Only Microsoft Edge and Internet Explorer (on a supported version of Microsoft

Windows) support ClickOnce applications out of the box. If you're using Chrome, you must install a ClickOnce

extension, such as Meta4 to use ClickOnce applications. If you use Chrome in incognito mode, make sure that the

ClickOnce extension is also enabled for incognito mode.

To preview PDF files, we recommend that you use browsers such as Microsoft Edge (latest publicly available version) on

Windows 10, or Google Chrome (latest publicly available version) on Windows 10, Windows 8.1, Windows 8, Windows

7, or Google Nexus 10 tablet.

The app is designed for networks that have a latency of 250–300 milliseconds (ms) or less. This latency is the

latency from a browser client to the Microsoft Azure datacenter that hosts the app. We recommend that you

test network latency at AzureSpeed.com.

Bandwidth requirements for the app depend on your scenario. Most typical scenarios require a bandwidth

that is more than 50 kilobytes per second (KBps). However, we recommend more bandwidth for scenarios

that have high payload requirements, such as scenarios that involve workspaces or extensive customization.

In general, the app is optimized for the internet. The number of round trips from a browser client to the Azure

datacenter is very small, and the whole payload is compressed.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/system-requirements.md
https://support.microsoft.com/microsoft-edge/download-the-new-microsoft-edge-based-on-chromium-0f4a3dd7-55df-60f5-739f-00010dba52cf
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/get-started/removed-deprecated-features-platform-updates#platform-updates-for-version-10015-of-finance-and-operations-apps
https://chrome.google.com/webstore/detail/meta4-clickonce-launcher/jkncabbipkgbconhaajbapbhokpbgkdc
https://www.azurespeed.com
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.NET Framework requirements

Supported Microsoft Office applications

Requirements for development on local VMs

Database collation

Additional resources

NOTENOTE

Don't calculate bandwidth requirements from a client location by multiplying the number of users by the minimum

bandwidth requirements. The concurrent usage of a given location is very difficult to calculate. Customers who are

concerned about bandwidth requirements should use a preview version of the app.

The app requires the Microsoft .NET Framework version 4.6.2 for all ClickOnce applications, such as the

document routing agent. For installation instructions, see Install the .NET Framework for developers.

The following Microsoft Office applications are supported in cloud:

To run the Microsoft Excel and Word add-ins, you must have Microsoft Office 2016 for Windows installed.

For more information about version requirements, see Troubleshoot the Office integration.

To view documents that are generated by the Export to Excel or Export to Word functionality, you must have

Microsoft Office 2007 or later installed.

For information about the requirements for development on local virtual machines (VMs), see VM that is

running locally.

The only supported collation for application databases in the cloud is SQL_Latin1_General_CP1_CI_ASSQL_Latin1_General_CP1_CI_AS .

Please ensure that your SQL Server and database collations in development environments are set to this. Also

ensure that any configuration environments that are published to Sandbox have this same collation.

Get evaluations copies

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://msdn.microsoft.com/library/5a4x27ek(v=vs.110).aspx
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-tools/access-instances
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-tools/get-evaluation-copy
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Get started

Onboard

Work in your on-premises deployment

Commerce

Upgrade

You can deploy Dynamics 365 Finance + Operations (on-premises). When you choose an on-premises

deployment type, the system requirements, hardware sizing, and functionality differ from a cloud deployment.

This topic provides links to content that contains information specific to on-premises deployments.

On-premises deployment overview

Plan and prepare for on-premises deployments

System requirements for on-premises deployments

Hardware sizing requirements for on-premises environments

Buy Finance + Operations (on-premises)

Comparison of cloud and on-premises features

Set up on-premises projects in Lifecycle Services (LCS)

Set up and deploy on-premises environments (Platform update 12 and later)

Install network printer devices in on-premises environments

Configure SQL Server Reporting Services for on-premises deployments

Develop and deploy custom models to on-premises environments

Configure document management

Import Electronic reporting (ER) configurations

Document generation, publishing, and printing in on-premises deployments

Configure proxies for on-premises environments

Set up technical support for Finance and Operations apps

Client internet connectivity

Apply updates to on-premises deployments

Redeploy on-premises environments

Reuse the same AD FS instance for multiple environments

Commerce capabilities that are available in on-premises deployments

Installation steps for Retail channel components in an on-premises environment

Configure, install, and activate Modern POS (MPOS)

Configure and install Commerce Scale Unit

In-place upgrade process for on-premises environments

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/deployment/on-premises-deployment-landing-page.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/on-premises-overview
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/plan-onprem-deployment
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/hardware-sizing-on-premises-environments
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/lbd-create-lcs-on-prem-project
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/setup-deploy-on-premises-pu12
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/develop-deploy-custom-models-on-premises
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/onprem-reverseproxy
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/support-experience
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/user-interface/client-disconnected
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/redeploy-on-prem
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/onprem-reuseadfs
file:///T:/eiye/ac1a/dynamics365/retail/retail-onprem.html
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/deploy-retail-onprem
file:///T:/eiye/ac1a/dynamics365/retail/retail-modern-pos-device-activation.html
file:///T:/eiye/ac1a/dynamics365/retail/dev-itpro/retail-store-scale-unit-configuration-installation.html
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/migration-upgrade/on-prem-upgrade


Other resources
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Troubleshoot on-premises deployments

Scripts for resolving issues in on-premises environments

Certificate rotation

On-premises diagnostics

Removed or deprecated features for Finance and Operations

Software lifecycle policy and on-premises releases

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/troubleshoot-on-prem
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/onprem-tsg-implementations
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/certificate-rotation-on-prem
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/on-premises-diagnostics
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

Network requirements

Network response timeNetwork response time

VA L UEVA L UE W EB  B RO W SER TO  A O SW EB  B RO W SER TO  A O S A O S TO  DATA B A SEA O S TO  DATA B A SE

Bandwidth 50 kilobytes per second (KBps) per
user

100 megabytes per second (MBps)

Latency Less than 250–300 milliseconds (ms) Less than 1 ms (local area network
[LAN] only). AOS and the database
must be co-located.

This topic lists the system requirements for the current version of Microsoft Dynamics 365 Finance +

Operations (on-premises) deployments. Before you install, when this step is appropriate, verify that the system

that you're working with meets or exceeds the minimum network, hardware, and software requirements.

Dynamics 365 Finance + Operations (on-premises) deployments are not supported on any public cloud infrastructure,

including Azure.

Dynamics 365 Finance + Operations (on-premises) can work on networks that use Internet Protocol Version 4

(IPv4) or Internet Protocol Version 6 (IPv6). Consider the network environment when you plan your system, and

use the following guidelines.

The following table lists the minimum network requirements for the connection between the web browser and

Application Object Server (AOS), and for the connection between AOS and the database in an on-premises

system.

Finance + Operations is designed for networks that have a latency of 250–300 milliseconds (ms) or less. This

latency is the latency from a browser client to the datacenter that hosts Finance + Operations.

Bandwidth requirements depend on your scenario. Typical scenarios require a bandwidth of more than

50 KBps between the browser and the server. However, we recommend higher bandwidth for scenarios that

have high payload requirements, such as scenarios that involve workspaces or extensive customization. The

specific amount of bandwidth depends on use.

Deployments where AOS and the Microsoft SQL Server database are in different datacenters aren't supported.

AOS and the SQL Server database must be co-located.

In general, Finance + Operations is optimized to reduce browser-to-server round trips. The number of round

trips from a browser client to the datacenter is either zero or one for each user interaction, and the payload is

compressed.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/system-requirements-on-prem.md


WARNINGWARNING

LAN environmentsLAN environments

WAN environmentsWAN environments

Internet connectivity requirementsInternet connectivity requirements

Browser clientBrowser client An intranet scenario without internet connectivity is a design
point for the on-premises deployment option. Some features
that require cloud services won't be available, such as Help
and Task guide libraries in Microsoft Dynamics Lifecycle
Services (LCS).

Ser verSer ver The AOS or Microsoft Azure Service Fabric tier must be able
to communicate with LCS. The on-premises browser-based
client doesn't require internet access.

Telemetr yTelemetr y Telemetry data might be lost if there are long interruptions
in connectivity. Interruptions in connectivity to LCS don't
affect the on-premises application functionality.

LCSLCS Connectivity to LCS is required for deployment, code
deployment, and servicing operations.

Telemetry data transfer to the cloud

Domain requirements

Don't calculate bandwidth requirements from a client location by multiplying the number of users by the minimum

bandwidth requirements. The concurrent usage of a given location is very difficult to calculate. We recommend that you

use a real-life simulation against a non-production environment as the best gauge of performance for your specific case.

In LAN environments, Microsoft Remote Desktop in Microsoft Windows Server isn't required in order to connect

to Finance + Operations. However, Remote Desktop might be required for servicing operations on the virtual

machines (VMs) that make up the server deployments.

In wide area network (WAN) environments, Remote Desktop in Windows Server isn't required in order to

connect to Finance + Operations.

Finance + Operations doesn't require internet connectivity from user workstations. However, some features

won't be available if there is no internet connectivity.

Most telemetry data is stored locally and can be accessed by using Event Viewer in Microsoft Windows. A small

subset of telemetry events is transferred to the Microsoft telemetry pipeline in the cloud for diagnostics.

Customer data and user-identifiable data aren't part of the telemetry data that is sent to Microsoft. VM names

are sent to Microsoft to help with environment management and diagnostics from the LCS portal.

Consider the following domain requirements when you install Finance + Operations:

VMs that host Finance + Operations components must belong to an Active Directory domain. Active

Directory Domain Services (AD DS) must be configured in native mode.

VMs that run Finance + Operations components must have access to each other. This access is configured in

AD DS.

The domain controller must be Microsoft Windows Server 2012 R2 or later, and the domain functional level

must be 2012 R2 or more.



  Full 2-way trustFull 2-way trust

Known limitations with using the full 2-way trust setupKnown limitations with using the full 2-way trust setup

Hardware requirements

Minimum infrastructure requirements

For compatibility with corporate domain controllers on Windows Server 2008 R2 domain functional level (DFL),

a full 2-way trust between the Windows Server 2008 R2 DFL user domain and the Windows Server 2012 R2

DFL Finance + Operations service domain is supported in Platform update 33 and later.

This means that users of the Finance + Operations (on-premises) application will come from the Windows

Server 2008 R2 DFL domain, and the resources and service accounts hosting the Finance + Operations (on-

premises) infrastructure and services will come from the Windows Server 2012 R2 DFL domain.

Examples for a full 2-way trust setup could be.

Import of security groups from the Windows Server 2008 R2 user domain is not supported.

This section describes the hardware that is required in order to run Finance + Operations.

The actual hardware requirements vary, based on the system configuration, the data composition, and the

features that you decide to use. Here are some of the factors that can affect the choice of appropriate hardware:

The number of transactions per hour

The number of concurrent users

Finance + Operations uses Service Fabric to host the AOS, Batch, Data management, Management reporter, and

Environment orchestrator services.

SQL Server must have a high-availability HADRON setup that has at least two nodes for production use.

The following illustration shows the minimum number of nodes that is recommended for your Service Fabric

cluster.



Processor and RAM requirements

NOTENOTE

TO P O LO GYTO P O LO GY RO L E ( N O DE T Y P E)RO L E  ( N O DE T Y P E)
REC O M M EN DEDREC O M M EN DED
P RO C ESSO R C O RESP RO C ESSO R C O RES

REC O M M EN DED M EM O RYREC O M M EN DED M EM O RY
( GB )( GB )

Production AOS, Data management,
Batch

8 24

Management Reporter 4 16

SQL Server Reporting
Services

4 16

Orchestrator 4 16

SQL Server 8 32

Sandbox AOS, Data management,
Batch

4 24

Management Reporter 4 16

The following tables list the number of processors and the amount of random-access memory (RAM) that are

required for each role that is required in order to run this deployment option. For more information, see the

recommended minimum requirements for a Service Fabric standalone cluster in Plan and prepare your Service

Fabric cluster.

If other Microsoft software is installed on the same computer, the system must also comply with the hardware

requirements for that software. If other server applications are installed on the same computer as AOS, we recommend

that you limit those server applications 1 gigabyte (GB) of RAM.

Sizing by role and topology typeSizing by role and topology type

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/media/minimum-infrastructure-jan2017.png
https://docs.microsoft.com/en-us/azure/service-fabric/service-fabric-cluster-standalone-deployment-preparation


SQL Server Reporting
Services

4 16

Orchestrator 4 16

SQL Server 8 32

TO P O LO GYTO P O LO GY RO L E ( N O DE T Y P E)RO L E  ( N O DE T Y P E)
REC O M M EN DEDREC O M M EN DED
P RO C ESSO R C O RESP RO C ESSO R C O RES

REC O M M EN DED M EM O RYREC O M M EN DED M EM O RY
( GB )( GB )

TO P O LO GYTO P O LO GY RO L ERO L E N UM B ER O F  IN STA N C ESN UM B ER O F  IN STA N C ES

Production AOS (Data management, Batch) 3

Management Reporter 2

SQL Server Reporting Services 1

Orchestrator** 3

SQL Server 2

Sandbox AOS, Data management, Batch 2

Management Reporter 1

SQL Server Reporting Services 1

Orchestrator 3

SQL Server 1

Summary for production and sandbox
topologies

19

RO L ERO L E
VM S/ IN STA NVM S/ IN STA N
C ESC ES C O RESC O RES TOTA L  C O RESTOTA L  C O RES

M EM O RY  P ERM EM O RY  P ER
IN STA N C EIN STA N C E
( GB )( GB )

TOTA LTOTA L
M EM O RYM EM O RY
( GB )( GB )

SharedShared
infrastructuinfrastructu
rere

SQL Server* 2 8 16 32 64

Minimum sizing estimates for production and sandbox deploymentsMinimum sizing estimates for production and sandbox deployments

* The numbers in this table are being validated by our preview customers and might be adjusted based on the

feedback from those customers.

** Orchestrator is designated as the primary node type and will also be used to run the Service Fabric services.

Initial estimates for the back-end SQL Ser ver and AD DSInitial estimates for the back-end SQL Ser ver and AD DS



File
server/Storag
e area
network/High
ly available
storage

The back-end storage must be based on solid-state drives (SSDs) on a runtime storage
area network (SAN).

Active
Directory

3 4 12 16 48

Summary for
shared
infrastructure

5 28 112

RO L ERO L E
VM S/ IN STA NVM S/ IN STA N
C ESC ES C O RESC O RES TOTA L  C O RESTOTA L  C O RES

M EM O RY  P ERM EM O RY  P ER
IN STA N C EIN STA N C E
( GB )( GB )

TOTA LTOTA L
M EM O RYM EM O RY
( GB )( GB )

Storage

Virtual host requirements

Software requirements for all server computers

Size and input/output operations per second (IOPS) throughput is based on the size
of the workload.

* SQL Server sizes are highly dependent on workloads. For more information, see Hardware sizing

requirements for on-premises environments. Separate SQL Server machines for sandbox and production

environments must be used. However, SQL Server can be shared in all sandbox environments.

AOSAOS  – Finance + Operations uses a Server Message Block (SMB) 3.0 share to store unstructured data.

For more information, see Storage Spaces Direct in Windows Server 2016.

SQLSQL  – The following options are viable:

A highly available SSD setup

A SAN that is optimized for online transaction processing (OLTP) throughputs

High-performance direct-attached storage (DAS)

SQL Ser ver and data management IOPSSQL Ser ver and data management IOPS  – The storage for both data management and SQL Server

should have at least 2,000 IOPS. Production IOPS depends on many factors. For more information, see

Hardware sizing requirements for on-premises environments.

VM IOPSVM IOPS  – Each VM should have at least 100 write IOPS.

When you set up the virtual hosts for an environment, see the guidelines in Plan and prepare your Service

Fabric cluster and Describing a service fabric cluster. Each virtual host should have enough cores for the

infrastructure that is being sized. Multiple advanced configurations are possible, where SQL Server resides on

physical hardware but everything else is virtualized. If SQL Server is virtualized, the disk subsystem should be a

fast SAN or the equivalent. In all cases, make sure that the basic setup of the virtual host is highly available and

redundant. In all cases, when virtualization is used, no VM snapshots should be taken.

Finance + Operations falls under Microsoft's standard support policy regarding operation on non-Microsoft

virtualization platforms – specifically VMWare. For more information, read Support policy for Microsoft

software. In short, we support our products in this environment, but if we are asked to investigate an issue, we

may ask the customer to first reproduce the problem without the virtualization platform or on the Microsoft

virtualization platform.

The following software must be present on a computer before any Finance + Operations components can be

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/hardware-sizing-on-premises-environments
https://docs.microsoft.com/en-us/windows-server/storage/storage-spaces/storage-spaces-direct-overview
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/hardware-sizing-on-premises-environments
https://docs.microsoft.com/en-us/azure/service-fabric/service-fabric-cluster-standalone-deployment-preparation
https://docs.microsoft.com/en-us/azure/service-fabric/service-fabric-cluster-resource-manager-cluster-description
https://support.microsoft.com/help/897615/support-policy-for-microsoft-software-that-runs-on-non-microsoft-hardw


Supported server operating systems

O P ERAT IN G SY ST EMO P ERAT IN G SY ST EM N OT ESN OT ES

Microsoft Windows Server 2016 Datacenter or Standard These requirements are for the database and the Service
Fabric cluster that hosts AOS.

Software requirements for database servers

REQ UIREM EN TREQ UIREM EN T N OT ESN OT ES

Microsoft SQL Server 2016 Standard Edition or Enterprise
Edition

For the hardware requirements for SQL Server 2016, see
Hardware and Software Requirements for Installing SQL
Server 2016.

Software requirements for Application Object Server (AOS)

Software requirements for Reporting Server (BI)

Software requirements for client computers

installed:

The Microsoft .NET Framework. See Deployment setup for version information.

Service Fabric

For more information, see Plan and prepare your Service Fabric cluster.

The following table lists the server operating systems that are supported.

Only en-US OS installations are supported.

Only 64-bit versions of SQL Server 2016 are supported.

Only SQL_Latin1_General_CP1_CI_ASSQL_Latin1_General_CP1_CI_AS  is valid for the server and database collation. For more information

about how to select a collation for a SQL Server database, see the SQL Server documentation.

In a production environment, we recommend that you install the latest cumulative update (CU) for the

version of SQL Server that you're using.

The following table lists the SQL Server versions that are supported for the databases. For more information,

see the minimum hardware requirements for SQL Server.

SQL Server Integration Services (SSIS)

SQL Server Reporting Services (SSRS)

Users can access Finance + Operations by using the most recent versions of these popular browsers:

Microsoft Edge (recommended: Chromium-based Edge)

Google Chrome

Apple Safari

Internet Explorer 11 (deprecated, not recommended)

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/setup-deploy-on-premises-pu12
https://docs.microsoft.com/en-us/azure/service-fabric/service-fabric-cluster-standalone-deployment-preparation
https://docs.microsoft.com/en-us/sql/sql-server/sql-server-technical-documentation
https://www.microsoft.com/sql-server/sql-server-2016
https://docs.microsoft.com/en-us/sql/sql-server/install/hardware-and-software-requirements-for-installing-sql-server
https://support.microsoft.com/microsoft-edge/download-the-new-microsoft-edge-based-on-chromium-0f4a3dd7-55df-60f5-739f-00010dba52cf


NOTENOTE

Software requirements for Active Directory Federation Services

Supported Microsoft Office applications

Hardware and software requirements for Commerce components

NOTENOTE

For optimal performance and an optimal experience, we recommend that you use the latest version of a modern browser,

especially Microsoft Edge. Support for Internet Explorer 11 is deprecated. For more information, see the Internet Explorer

deprecation announcement.

Active Directory Federation Services (AD FS) on Windows Server 2016 is required.

The domain controller must be Windows Server 2012 R2 or later, and the domain functional level must be 2012

R2 or more. For more information about domain functional levels, see the following pages:

What Are Active Directory Functional Levels

Understanding Active Directory Domain Services Functional Levels

Full 2-way trust

The following Microsoft Office applications are supported in on-premises deployments:

To run the Microsoft Excel and Microsoft Word add-ins, you must have Microsoft Office 2016 for Windows

(or newer) installed. For more information about version requirements, see Troubleshoot the Office

integration.

To view documents that are generated by the Export to Excel or Export to Word functionality, you must have

Microsoft Office 2007 or later installed.

Currently, Finance + Operations doesn't include the Commerce components.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/get-started/removed-deprecated-features-platform-updates#platform-updates-for-version-10015-of-finance-and-operations-apps
https://technet.microsoft.com/library/cc787290(v=ws.10).aspx
https://technet.microsoft.com/library/understanding-active-directory-functional-levels(v=ws.10).aspx
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

Purchase client access licenses

Purchase server licenses

NOTENOTE

Get started with Lifecycle Services (LCS)

Microsoft Dynamics 365 Finance + Operations (on-premises) offers a variety of license types to best suit the

needs of your organization. To better understand how Finance + Operations (on-premises) is licensed, please

work with your partner, who can access the Licensing guide on PartnerSource. When you are ready to purchase

licenses for your organization, work with your partner to follow the steps outlined in this topic.

On-premises environments are not supported on any public cloud infrastructure, including Azure.

To run on-premises environments, you must obtain the proper number of client access licenses (CALs) for your

organization per the licensing guide. The CAL purchased for an individual user determines the functionality that

the user has the rights to use. User CALs can be purchased from the Microsoft Volume Licensing Service Center.

A server license is required for every server running Finance + Operations (on-premises). After purchasing your

server licenses, work with your partner to download a license file from the PartnerSource Business Center. Keep

this license file handy, as the details it contains will be used when setting up your Lifecycle Services (LCS)

project.

Partners can download a customer's Finance + Operations (on-premises) license file from the PartnerSource

Business Center using these steps:

1. Log on to the PartnerSource Business Center.

2. Enter the customer name or account number in the Find A CustomerFind A Customer  field, and then click SearchSearch.

3. Click the company name of the customer. This opens the Customer Summar yCustomer Summar y  page.

4. Under Registered ProductsRegistered Products , click Registration KeysRegistration Keys .

5. Select version 07version 07  in the Request and Display L icense Keys For VersionRequest and Display L icense Keys For Version field.

6. Click Display L icense KeysDisplay L icense Keys .

7. On the Request L icense KeysRequest L icense Keys  page, select Download Current L icense/Registration KeyDownload Current L icense/Registration Key .

8. Click Save AsSave As  in the File DownloadFile Download dialog box, select the folder where you want to download the license

file to in the Save AsSave As  dialog box, and then click SaveSave.

If you cannot see registration keys in PartnerSource Business Center, you will need to ensure that your PartnerSource

Business Center Profile has Can See Registration KeysCan See Registration Keys set to YesYes .

To purchase Finance + Operations (on-premises) you must have a Microsoft Online Services ID. The Microsoft

Online Services ID is used to provision an LCS project that contains the necessary artifacts for on-premises

environments. LCS is the service where on-premises environments will be provisioned, Business Process Model

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/purchase-on-premises.md
https://mbs.microsoft.com/Files/public/365/DynamicsOperationsOnPremEnterprise.pdf
https://www.microsoft.com/Licensing/servicecenter/default.aspx
https://businesscenter.mbs.microsoft.com/
https://businesscenter.mbs.microsoft.com/


NOTENOTE

created/uploaded, hotfixes are made available, support cases are entered and managed, license key serial

number activation submitted, etc.

The Microsoft Online Services ID is required to provision and register Finance + Operations (on-premises) into

entity-owned hardware and environment. See the Provisioning guide (linked to below) to complete the

provisioning and registration process. If a Microsoft Online Services ID already exists, the process must be

completed by the Global Administrator. If creating a Microsoft Online Services ID for the first time, the person

initiating the process will be the Global Administrator.

If you have an existing Microsoft Online Services trial or paid subscription, you already have a Microsoft Online

Services ID that was created at the time of sign-up. When you click a link below, choose to sign in with this

account if you want to use this same Azure Active Directory (AAD) tenant for the on-premises environment.

Access to the Provisioning guide can be found here:

Provisioning guide on CustomerSource

Provisioning guide on PartnerSource

After you have logged into LCS, a project will be automatically provisioned for you. The LCS project will allow

you to deploy an on-premises environment. For more details on getting started with your LCS project, see Set

up on-premises projects in Lifecycle Services (LCS).

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://go.microsoft.com/fwlink/?linkid=852080
https://mbs.microsoft.com/partnersource/global/deployment/documentation/user-guides/D365Ops_OnPremEEProvisionGuide
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/lbd-create-lcs-on-prem-project
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Prerequisites

P L AT F O RMP L AT F O RM VERSIO NVERSIO N

Android 4.4 and up

Windows (UWP) Windows 10 (all versions)

App version 1.1.1.0 and above

Dynamics 365 Dynamics 365 Finance + Operations (on-premises) with
Platform update 11

Create an application entry in AD FS

This topic describes how to configure Dynamics 365 for Finance and Operations – Warehousing app for on-

premises deployments.

The Warehousing app is available on Android and Windows operating systems. To use the app for on-premises

deployments, at a minimum, it must be version 1.1.1.0. You must also have one of the following supported

versions of Dynamics 365 Finance + Operations (on-premises). Use the information in the following table to

evaluate if your hardware and software environment supports the configuration.

To be able to reach your on-premises resources with the app, you will need to create DNS records for your AOS

and for Active Directory Federation Services (AD FS). For guidance, see Create DNS zones, and add a record.

For a successful authentication exchange between AD FS and Finance + Operations, an application entry must

be registered in AD FS under an AD FS application group. To create this application entry, run the following

Windows PowerShell commands on a machine where the AD FS is installed. The user account must have

enough permissions to administer AD FS.

Add-AdfsClient -Name 'Dynamics 365 for Finance and Operations - Warehousing' -ClientId 
([guid]::NewGuid()) -ClientType Confidential -GenerateClientSecret -RedirectUri '\<Resource URL\>' -
ADUserPrincipalName '\<Admin user\>' 

1. Enter the following command in the Windows PowerShell console to create the application entry.

The <Resource URL> can, for example, be https://ax.d365ffo.onprem.contoso.com  (where 

https://ax.d365ffo.onprem.contoso.com  is the URL to access Finance + Operations).

The <Admin user> can be any user with admin access to the AD FS machine.

2. Save the values that you received.

3. Run the following command to grant permission to the application.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/deployment/warehousing-for-on-premise-deployments.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/setup-deploy-on-premises-pu12


Create and configure a user account

Grant-AdfsApplicationPermission -ClientRoleIdentifier '\<Client ID received in previous steps\>' -
ServerRoleIdentifier '\<Resource URL\>' -ScopeNames 'openid'

To enable Finance + Operations to use your AD FS application, you must create a user account in Microsoft

Dynamics 365 with the same user credentials as the user of the Warehousing app:

1. Create a user in Finance + Operations and assign the Warehousing mobile device user role to the user.

a. Go to System administrationSystem administration > CommonCommon > UsersUsers .

b. Create a new user.

c. Assign the warehouse mobile device user role, as shown in the example screenshot.

2. Associate your AD FS application with the Warehousing app user.

a. In Finance + Operations, click System administrationSystem administration > SetupSetup > Azure Active Director yAzure Active Director y

applicationsapplications .

b. Create a new line.

c. Enter the client ID that you obtained when you created an application entry in AD FS (step 2 in "Create

an application entry in AD FS"). Enter a name, and select the Warehousing app user.



Certificates

IMPORTANTIMPORTANT

Configure the application

NOTENOTE

Make sure that the devices with the app installed have the correct certificates to access the resources. If you are

using self-signed certificates, these will need to be installed on each device by importing star(AX) and AD FS to

the trusted route of the computer account/user account. For more information, see Create and export a self-

signed certificate.

Environments with self-signed certificates will not be accessible from Android devices. If you need to access the

environment from an Android device, use publicly trusted certificates for AD FS and Finance + Operations. Alternatively,

you can also use AD CS to generate the certificates for AD FS and Finance + Operations. However, if you do this you will

have to manually import the certificate authority certificate into your Android device.

You must configure the Warehousing app on the device to connect to the server through the AD FS application.

1. In the app, open Connection settingsConnection settings .

2. Enter the following information:

a. Active Director y Client IDActive Director y Client ID - The client ID that you obtained when you created an application entry in

AD FS (step 2 in "Create an application entry in AD FS").

b. Active Director y Client SecretActive Director y Client Secret - The client secret obtained when you created an application entry in

AD FS.

c. Active Director y ResourceActive Director y Resource - The DNS URL for the AOS. Append the URL with '/namespaces/AXSF'.

For example: https://ax.d365ffo.onprem.contoso.com/namespaces/AXSF

d. Active Director y TenantActive Director y Tenant - The DNS URL for the AD FS machine. Append the URL with '/adfs/oauth2'.

For example: https://adfs.d365ffo.onprem.contoso.com/adfs/oauth2  Make sure to use the CNAME of the

ADFS machine (in the example the CNAME is https://adfs.d365ffo.onprem.contoso.com )

3. CompanyCompany  - Enter the legal entity to which you want the application to connect.

4. Select the BackBack button in the top-left corner of the application.

The application will now connect to your server and the log-in screen for the warehouse worker will

display.

5. If you do not have a telemetry ID for the Warehouse app, you might encounter some errors. This is a

known issue. The workaround is to sign in to an existing client to get a Telemetry ID. This issue will be

fixed in a future release.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://technet.microsoft.com/library/ff710475(v=ws.10).aspx
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

Provisioning

Features not available

Effective November 2020:

Common Data Service has been renamed to Microsoft Dataverse. For more information, see Power Automate Blog.

Some terminology in Microsoft Dataverse has been updated. For example, entity is now table and field is now column.

For more information, see Terminology updates.

This topic will be updated soon to reflect the latest terminology.

Microsoft Dynamics 365 online services operated by 21Vianet is designed to comply with regulatory

requirements in China. The services are a physically separated instance of cloud services operated and

transacted by a local operator, Shanghai Blue Cloud Technology Co., Ltd (“21Vianet21Vianet”). This is a wholly owned

subsidiary of Beijing 21Vianet Broadband Data Center Co., Ltd. located in mainland China.

Microsoft strives to maintain functional parity between our commercially available service and Finance and

Operations apps operated by 21Vianet in China. However, there are notable exceptions to this, which are

affected by dependent service or partner-solution availability, market priorities, or compliance regulations.

Customers in China have two options from which to select how they want to access Finance and Supply Chain

Management apps.

Services operated by 21Vianet in China - 21Vianet operates and offers Finance and Supply Chain

Management services in China. This option provides a consistent application experience that is the same

as global offerings. This option also meets the demands of customers who prefer to use online services

provided by a local company that stores their data within China. These services are subject to Chinese

laws.

Services operated by Microsoft – This option is for Finance and Supply Chain Management customers

that prefer to use services managed and delivered by Microsoft. For all new customers and existing

customers, if the customer purchases Microsoft Azure, Dynamics 365, and Office using an Enterprise

Agreement, Microsoft 365 and/or Dynamics 365 can co-exist on the tenant.

For information on provisioning environments, see Create and manage environments in the Power Platform

Admin center.

Due to certain technical dependencies, the following features listed will not be available for general availability

of the Dynamics 365 Services operated by 21Vianet. For information about future feature availability, see

Business applications and platform release plans.

Development, build, and testing of customizationsDevelopment, build, and testing of customizations  will be unavailable in Azure DevOps inAzure DevOps in

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/deployment/china-local-deployment.md
https://aka.ms/PAuAppBlog
https://go.microsoft.com/fwlink/?linkid=2147247
https://docs.microsoft.com/en-us/power-platform/admin/create-environment
https://go.microsoft.com/fwlink/?linkid=2010158
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Additional resources

Mainland ChinaMainland China. However, use of Azure DevOps on-premises will be available in China in April 2019.

Also, Azure DevOps can be used in other regions. For more information, see Developer guide for Azure

China 21Vianet.

Set up and maintain vendor collaboration will be unavailable due to Azure Active Directory limitations.

Certain mobile appsmobile apps  (e.g., Install and configure the Warehousing app overview and Project time entry

mobile workspace) will be unavailable due to the Google Play Store not being available in China; however,

alternatives are being considered.

The mobile platformmobile platform will not be available because certain App store dependencies are unavailable in

China.

The following Microsoft Dynamics L ifecycle Ser vices (LCS)Microsoft Dynamics L ifecycle Ser vices (LCS)  features will have a different experience

or will be unavailable due to the dependencies that are not available:

APQC Business process modeler (BPM) L ibrar yAPQC Business process modeler (BPM) L ibrar y  will be unavailable. However, base Business

process modeler (BPM) functionality will be available for custom models in April 2019. Search

functionality in the BPM will be unavailable in China.

Electronic repor ting (ER) over viewElectronic repor ting (ER) over view  assets assets  will not be available automatically, but can be

manually uploaded from the LCS global asset library.

Code upgradeCode upgrade will be unavailable for upgrades from Dynamics AX 2012.

Ser vice and Suppor t requestsSer vice and Suppor t requests  will be available through LCS but 21Vianet is the service

operator. For more information, see Support for Dynamics 365 Finance and Operations apps

operated by 21Vianet in China.

Extensibility requests will be unavailable.

Hotfix requests will be unavailable.

Dynamics 365 Translation Service overview will not be available.

Embedded Power Apps and connectivity to Microsoft Power Apps and Microsoft Power Automate

will be unavailable.

Data integration using Dataverse overview will be unavailable.

The Lifecycle Services URL for implementations operated by 21Vianet in China is lcs.dynamics.cn.

The following features will not be available due to certain current Azure Active Director y limitationscurrent Azure Active Director y limitations

in China:

The System administration > Setup > B2B Invitation configurationSystem administration > Setup > B2B Invitation configuration page will not be available

due to business-to-business (B2B) being unavailable in Azure Active Directory in China. For more

information, see What is guest user access in Azure Active Directory B2B.

Conditional access is an Azure Active Directory feature that is available for the Azure Active Directory

Premium 2 SKU. This is unavailable in China. 

The Microsoft Dynamics 365 Payment Connector for PayPal is not available in China.

Dynamics 365 support site for 21Vianet (Chinese)

https://docs.microsoft.com/en-us/azure/china/china-get-started-developer-guide
file:///T:/eiye/ac1a/dynamics365/finance/project-management/project-time-entry-mobile-workspace.html
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/mobile-apps/platform/mobile-platform-home-page
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/21vianet-support
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/extensibility/extensibility-requests
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/translation-service-overview
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/data-integration-cds
https://docs.microsoft.com/en-us/azure/active-directory/b2b/what-is-b2b
https://docs.microsoft.com/en-us/azure/active-directory/conditional-access/technical-reference
https://www.21vbluecloud.com/Dynamics365/
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Support for Dynamics 365 Finance and Operations apps operated by 21Vianet in China

Model-driven apps in Dynamics 365 - operated by 21Vianet in China

Dynamics 365 Privacy statement (Dynamics 365 隐私声明)

Dynamics 365 Service Level agreement (世纪互联在线服务的服务级别协议)

Dynamics 365 Legal information (Dynamics 365 法律信息)

Service terms for Dynamics 365 Lifecycle Services

OSPT of Dynamics 365 (世纪互联在线服务的服务级别协议)

Azure Docs (in Chinese)

Azure China 21Vianet

Business applications availability in China – operated by 21Vianet in China

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/21vianet-support
https://docs.microsoft.com/en-us/dynamics365/customer-engagement/admin/datacenter/about-microsoft-cloud-china
https://www.21vbluecloud.com/Dynamics365/d365-privacy/
https://www.21vbluecloud.com/Dynamics365/d365-sla/
https://www.21vbluecloud.com/Dynamics365/dynamics365-legal/
https://www.21vbluecloud.com/dynamics365/d365-lcs/
https://www.21vbluecloud.com/ostpt/
https://docs.azure.cn/zh-cn/
https://docs.microsoft.com/en-us/azure/china/china-welcome
https://docs.microsoft.com/en-us/power-platform/admin/business-applications-availability-china
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

As of July 2019, Finance and Operations apps, Power Apps, and Power Automate are available in France’s

datacenters. This new deployment option serves customers in regulated industry and commercial organizations

that do business with entities in France that require local data residency. Power BI has been available since

March 2019.

The deployment of the Dynamics 365 services in France, are built upon the foundational principles of security,

privacy, compliance, transparency, and reliability, offering French organizations a complete cloud infrastructure

and platform, as well as familiar productivity and business application tools. All of this means that customer data

stays resident within France.

Microsoft strives to maintain functional parity between our commercially available service and Dynamics 365

offerings in France. However, there are few exceptions affected by dependent service or partner-solution

availability, market priorities, or compliance regulations. For more information about these exceptions or for

questions about services in France, contact Microsoft Dynamics Online support.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/deployment/france-local-deployment.md
https://dynamics.microsoft.com/support/
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Application releases

Platform updates

Lifecycle Services releases

NOTENOTE

To see what's new or changed in each release of a Finance and Operations app, see the following topics:

Finance:Finance: What's new or changed in Dynamics 365 Finance

Supply Chain Management:Supply Chain Management: What's new or changed in Dynamics 365 Supply Chain Management

Commerce:Commerce: What's new or changed in Dynamics 365 Commerce

Human Resources:Human Resources: What's new or changed in Dynamics 365 Human Resources

To see what's new or changed in the Platform updates for Finance and Operations apps, see the following topic:

What's new or changed in Platform updates

To see what's new or changed in Lifecycle Services, see the following topic:

What's new or changed in Lifecycle Services (LCS)

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/whats-new-changed.md
https://docs.microsoft.com/en-us/dynamics365/finance/get-started/whats-new-home-page
file:///T:/eiye/ac1a/dynamics365/retail/get-started/whats-new-home-page.html
https://docs.microsoft.com/en-us/dynamics365/human-resources/hr-admin-whats-new
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/get-started/whats-new-home-page
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/whats-new-lcs
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Releases of Dynamics 365 Supply Chain Management

VERSIO NVERSIO N B UIL D N UM B ERB UIL D N UM B ER
A UTO -UP DAT EA UTO - UP DAT E
AVA IL A B IL IT YAVA IL A B IL IT Y L EA RN  M O REL EA RN  M O RE

10.0.16 10.0.689 February 2021 What's new or changed in
Dynamics 365 Supply Chain
Management version
10.0.16

10.0.15 10.0.644 January 2021 What's new or changed in
Dynamics 365 Supply Chain
Management version
10.0.15

10.0.14 10.0.605 November 2020 What's new or changed in
Dynamics 365 Supply Chain
Management version
10.0.14

10.0.13 10.0.569 October 2020 What's new or changed in
Dynamics 365 Supply Chain
Management version
10.0.13

10.0.12 10.0.507 August 2020 What's new or changed in
Dynamics 365 Supply Chain
Management version
10.0.12

10.0.11 10.0.464 July 2020 What's new or changed in
Dynamics 365 Supply Chain
Management version
10.0.11

10.0.10 10.0.420 May 2020 What's new or changed in
Dynamics 365 Supply Chain
Management version
10.0.10

10.0.9 10.0.383 April 2020 What's new or changed in
Dynamics 365 Supply Chain
Management version 10.0.9

To see what's new or changed in each release of Dynamics 365 Supply Chain Management, see the following

topics.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/get-started/whats-new-home-page.md
https://docs.microsoft.com/en-us/dynamics365/supply-chain/get-started/whats-new-scm-10-0-14
https://docs.microsoft.com/en-us/dynamics365/supply-chain/get-started/whats-new-scm-10-0-13
https://docs.microsoft.com/en-us/dynamics365/supply-chain/get-started/whats-new-scm-10-0-12
https://docs.microsoft.com/en-us/dynamics365/supply-chain/get-started/whats-new-scm-10-0-11
https://docs.microsoft.com/en-us/dynamics365/supply-chain/get-started/whats-new-scm-10-0-10
https://docs.microsoft.com/en-us/dynamics365/supply-chain/get-started/whats-new-scm-10-0-9


10.0.8 10.0.319 February 2020 What's new or changed in
Dynamics 365 Supply Chain
Management version 10.0.8

10.0.7 10.0.283 January 2020 What's new or changed in
Dynamics 365 Supply Chain
Management version 10.0.7

10.0.6 10.0.234 November 2019 What's new or changed in
Dynamics 365 Supply Chain
Management 10.0.6

VERSIO NVERSIO N B UIL D N UM B ERB UIL D N UM B ER
A UTO -UP DAT EA UTO - UP DAT E
AVA IL A B IL IT YAVA IL A B IL IT Y L EA RN  M O REL EA RN  M O RE

Releases before November 2019

REL EA SEREL EA SE VERSIO NVERSIO N B UIL D N UM B ERB UIL D N UM B ER AVA IL A B IL IT YAVA IL A B IL IT Y L EA RN  M O REL EA RN  M O RE

Microsoft Dynamics
365 for Finance and
Operations

10.0.5 10.0.197 October 2019 What's new or
changed in Dynamics
365 for Finance and
Operations version
10.0.5 (October
2019)

Microsoft Dynamics
365 for Finance and
Operations

10.0.4 10.0.136 July 2019 What's new or
changed in Dynamics
365 for Finance and
Operations version
10.0.4 (July 2019)

Microsoft Dynamics
365 for Finance and
Operations

10.0.3 10.0.107 June 2019 What's new or
changed in Dynamics
365 for Finance and
Operations version
10.0.3 (June 2019)

Microsoft Dynamics
365 for Finance and
Operations

10.0.2 10.0.80 May 2019 What's new or
changed in Dynamics
365 for Finance and
Operations version
10.0.2 (May 2019)

Microsoft Dynamics
365 for Finance and
Operations

10.0.1 10.0.51 April 2019 What's new or
changed in Dynamics
365 for Finance and
Operations version
10.0.1 (April 2019)

Microsoft Dynamics
365 for Finance and
Operations

10.0 10.0.8 April 2019 What's new or
changed in Finance
and Operations
version 10.0 (April
2019)

To see what's new or changed in releases before November 2019, see the following topics.

https://docs.microsoft.com/en-us/dynamics365/supply-chain/get-started/whats-new-scm-10-0-8
https://docs.microsoft.com/en-us/dynamics365/supply-chain/get-started/whats-new-scm-10-0-7
https://docs.microsoft.com/en-us/dynamics365/supply-chain/get-started/whats-new-scm-10-0-6
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/whats-new-changed-10-0-5
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/whats-new-changed-10-0-4
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/whats-new-changed-10-0-3
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/whats-new-changed-10-0-2
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/whats-new-changed-10-0-1
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/whats-new-changed-10-0-1


Microsoft Dynamics
365 for Finance and
Operations

8.1.3 8.1.227 January 2019 What's new or
changed in Dynamics
365 for Finance and
Operations version
8.1.3 (January 2019)

Microsoft Dynamics
365 for Finance and
Operations

8.1.2 8.1.195 December 2018 What's new or
changed in Dynamics
365 for Finance and
Operations version
8.1.2 (December
2018)

Microsoft Dynamics
365 for Finance and
Operations

8.1.1 8.1.170 October 2018 What's new or
changed in Dynamics
365 for Finance and
Operations version
8.1.1 (October 2018)

Microsoft Dynamics
365 for Finance and
Operations

8.1 8.1.136 October 2018 What's new or
changed in Dynamics
365 for Finance and
Operations version
8.1 (October 2018)

Microsoft Dynamics
365 for Finance and
Operations

8.0 8.0.30, 8.0.35 April 2018 What's new or
changed in Dynamics
365 for Finance and
Operations version
8.0 (April 2018)

Microsoft Dynamics
365 for Finance and
Operations,
Enterprise edition

7.3 7.3.11971.56116 December 2017 What's new or
changed in Dynamics
365 for Finance and
Operations,
Enterprise edition 7.3

Microsoft Dynamics
365 for Finance and
Operations,
Enterprise edition

July 2017 7.2.11792.56024 June 2017 What's new or
changed in Dynamics
365 for Finance and
Operations,
Enterprise edition
(July 2017)

Microsoft Dynamics
365 for Operations

1611 7.1.1541.3036 November 2016 What's new or
changed in Dynamics
365 for Operations
version 1611
(November 2016)

Microsoft Dynamics
AX

7.0.1 7.0.1265.23014 May 2016 What's new or
changed in Dynamics
AX application
version 7.0.1 (May
2016)

REL EA SEREL EA SE VERSIO NVERSIO N B UIL D N UM B ERB UIL D N UM B ER AVA IL A B IL IT YAVA IL A B IL IT Y L EA RN  M O REL EA RN  M O RE

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/whats-new-changed-8-1-3
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/whats-new-changed-8-1-2
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/whats-new-changed-8-1-1
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/whats-new-changed-8-1-october-2018
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/whats-new-changed-8-0-april-2018
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/whats-new-application-7.3-update
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/whats-new-application-july-2017-update
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/whats-new-dynamics-365-operations-1611
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/whats-new-changed-application-version-7-0-1-may-2016


Microsoft Dynamics
AX

7.0 7.0.1265.3015 February 2016 What's new or
changed in Dynamics
AX 7.0 (February
2016)

REL EA SEREL EA SE VERSIO NVERSIO N B UIL D N UM B ERB UIL D N UM B ER AVA IL A B IL IT YAVA IL A B IL IT Y L EA RN  M O REL EA RN  M O RE

NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/whats-new-changed-7-0-february-2016
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

Features included in this release

Asset managementAsset management

Inventory and logisticsInventory and logistics

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

This topic lists features that are either new or changed in the Microsoft Dynamics 365 Supply Chain

Management preview of version 10.0.17. This version has a build number of 10.0.761 and is available as follows:

Preview of release:Preview of release: February 2021

General availability of release (self-update):General availability of release (self-update): March 2021

General availability of release (auto-update):General availability of release (auto-update): April 2021

The following features are included in this release. Some of the listed features are still in preview, while others

may already be generally available. Follow the links to the release plan to see the official release dates for each

feature.

Most of these features must be enabled using Feature management before you can use them.

Apply rules for grouping work orders while running a maintenance plan

- For more information, see Creating work orders.

Bill customers for maintenance work

- For more information, see Bill for maintenance on customer-owned assets.

Plan maintenance based on accumulated asset counter values

- For more information, see Maintenance plans.

Integration framework for material handling equipment for automated warehouse processes (previously

MHAX)

Landed cost

Packing vs. storage dimensions

- For more information, see Set different dimensions for packing and storage.

Saved views for inventory and logistics

- For more information, see Standard saved views for Supply Chain Management.

Schedule warehouse work creation

- For more information, see Schedule work creation during wave.

Set default financial dimensions for inventory standard cost revaluation vouchers

- For more information, see Manage standard cost updates.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/get-started/whats-new-scm-10-0-17.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/planned-features
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/apply-rules-grouping-work-orders-while-running-maintenance-plan
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/bill-customers-maintenance-work
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/plan-maintenance-based-accumulated-asset-counter-values
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/integration-framework-material-handling-equipment-automated-warehouse-processes-previously-mhax
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/landed-cost
https://docs.microsoft.com/en-us/dynamics365-release-plan/2019wave2/dynamics365-supply-chain-management/packing-vs.-storage-dimensions
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/saved-views-inventory-logistics
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/schedule-warehouse-work-creation
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/set-default-financial-dimensions-inventory-standard-cost-revaluation-vouchers


ManufacturingManufacturing

PlanningPlanning

Product information managementProduct information management

New and updated documentation resources

Cost managementCost management

Asset managementAsset management

Inventory and logisticsInventory and logistics

Small parcel shipping (SPS)

- For more information, see Small parcel shipping.

Warehouse execution with scale units in the cloud

- For more information, see Warehouse management workloads for cloud and edge scale units and

Warehouse orders for cloud and edge scale units.

Warehouse management mobile application

- For more information, see Install and connect the Warehouse Management app and Mobile device user

settings.

Asset management capabilities in the production floor execution interface

- For more information, see How workers use the production floor execution interface.

Override the default reservation principle for materials in production

- For more information, see Override the default reservation principle for materials in production.

Saved views for production control

- For more information, see Standard saved views for Supply Chain Management.

Manufacturing execution with scale units in the cloud

- For more information, see Manufacturing execution workloads for cloud and edge scale units.

Coverage time fence support for Planning Optimization

- For more information, see Coverage time fences.

Forecast submodel support for Planning Optimization

- For more information, see Master planning with demand forecasts.

Purchase requisition support for Planning Optimization

- For more information, see Purchase requisitions.

Saved views for planned orders

- For more information, see Standard saved views for Supply Chain Management.

Enable change management on existing products

- For more information, see Enable change management on existing products.

We have recently added or significantly updated the following help topics. They aren't necessarily related to the

new features added for this release, as listed in the previous section, but they may help you to get more out of

existing features.

Troubleshoot cost management

Set up the Asset management mobile workspace

Configure product filters for warehouse transactions

Partial location cycle counting

https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/small-parcel-shipping-sps
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/warehouse-execution-scale-units-cloud
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/warehouse-management-mobile-application
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/asset-management-capabilities-production-floor-execution-interface
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/override-default-reservation-principle-materials-production
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/saved-views-production-control
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/manufacturing-execution-scale-units-cloud
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/coverage-time-fence-support-planning-optimization
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/forecast-submodel-support-planning-optimization
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/purchase-requisition-support-planning-optimization
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/saved-views-planned-orders
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/finance-operations/dynamics365-supply-chain-management/enable-change-management-existing-products


ManufacturingManufacturing

PlanningPlanning

Additional resources
Platform updates for Finance and Operations appsPlatform updates for Finance and Operations apps

Bug fixesBug fixes

Dynamics 365: 2021 release wave 1 planDynamics 365: 2021 release wave 1 plan

Removed and deprecated Supply Chain Management featuresRemoved and deprecated Supply Chain Management features

NOTENOTE

Pick line grouping

Troubleshoot inventory operations

Warehouse slotting

Design the production floor execution interface

Intercompany planning

Inventory marking with Planning Optimization

Production planning

Purchase requisitions in master planning

Microsoft Dynamics 365 Supply Chain Management 10.0.17 includes platform updates. To learn more, see

Platform updates for version 10.0.17 of Finance and Operations apps (April 2021).

For information about the bug fixes included in each of the updates that are part of 10.0.17, sign in to Lifecycle

Services (LCS) and view the KB article.

Wondering about upcoming and recently released capabilities in any of our business apps or platform?

Check out the Dynamics 365: 2021 release wave 1 plan. We've captured all the details, end to end, top to

bottom, in a single document that you can use for planning.

The Removed or deprecated features in Dynamics 365 Supply Chain Management topic describes features that

have been or are scheduled to be removed or deprecated for Supply Chain Management.

A removed feature is no longer available in the product.

A deprecated feature is not in active development and may be removed in a future update.

Before any feature is removed from the product, the deprecation notice will be announced in the Removed or

deprecated features in Dynamics 365 Supply Chain Management topic 12 months prior to the removal.

For breaking changes that only affect compilation time, but are binary compatible with sandbox and production

environments, the deprecation time will be less than 12 months. Typically, these are functional updates that need

to be made to the compiler.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/get-started/whats-new-platform-updates-10-0-17
https://fix.lcs.dynamics.com/Issue/Details?bugId=551039&dbType=3&qc=91219e7c3fc585acb17b810c915c3cbea499403538520c40e54de43a53aea6a8
https://docs.microsoft.com/en-us/dynamics365-release-plan/2021wave1/
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Features included in this release

New and updated documentation resources

This topic lists features that are either new or changed in Microsoft Dynamics 365 Supply Chain Management

version 10.0.16. This version has a build number of 10.0.689 and is available as follows:

Preview of release:Preview of release: November 2020

General availability of release (self-update):General availability of release (self-update): January 2021

General availability of release (auto-update):General availability of release (auto-update): February 2021

The following features are included in this release. Some of the listed features are still in preview, while others

may already be generally available. Follow the links to the release plan to see the official release dates for each

feature.

Customizable shop floor execution interface

- For more information, see Set up a device to run the production floor execution interface.

Inventory Visibility Add-in for Dynamics 365 Supply Chain Management

- For more information, see Inventory Visibility Add-in

Validate license plates on source document lines

- For more information, see Warehouse configuration overview.

Warehouse management outbound workload visualization

- For more information, see Outbound workload visualization

Most of these features must be enabled using Feature management before you can use them.

We have recently added or significantly updated the following help topics. They aren't necessarily related to the

new features added for this release, as listed in the previous section, but they may help you to get more out of

existing features.

Attribute-based sales prices for constraint-based product configuration

Automatic allocation of charges

Hazardous materials overview (and related topics)

Migration to Planning Optimization for master planning

Purchasing cXML Enhancements

Troubleshoot cost management

Troubleshoot inbound warehouse operations

Troubleshoot load building and shipments

Troubleshoot master planning

Troubleshoot outbound warehouse operations

Troubleshoot partial releases and partial shipments

Troubleshoot the product configurator

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/get-started/whats-new-scm-10-0-16.md
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave2/finance-operations/dynamics365-supply-chain-management/planned-features
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave2/finance-operations/dynamics365-supply-chain-management/customizable-shop-floor-execution-interface
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave2/finance-operations/dynamics365-supply-chain-management/inventory-visibility-add-in-dynamics-365-supply-chain-management-preview
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave2/finance-operations/dynamics365-supply-chain-management/validate-license-plates-source-document-lines
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave2/finance-operations/dynamics365-supply-chain-management/warehouse-management--workload-visualization


Additional resources
Platform updates for Finance and Operations appsPlatform updates for Finance and Operations apps

Bug fixesBug fixes

Dynamics 365: 2020 release wave 2 planDynamics 365: 2020 release wave 2 plan

Removed and deprecated Supply Chain Management featuresRemoved and deprecated Supply Chain Management features

Troubleshoot product information

Troubleshoot procurement and sourcing workflows

Troubleshoot purchase orders

Troubleshoot prices, discounts, agreements, and rebates

Troubleshoot product receipts and invoicing

Troubleshoot discrete manufacturing

Troubleshoot picking and packing

Troubleshoot process manufacturing

Troubleshoot reservations in warehouse management

Troubleshoot sales orders

Troubleshoot sales quotations

Troubleshoot upgrade and migration to advanced warehouse management

Troubleshoot warehouse app connection issues

Troubleshoot warehouse configuration

Troubleshoot warehouse replenishment

Troubleshoot warehouse setup

Troubleshoot warehouse work

Putaway clusters

Replenishment strategies

Work split

Work with location directives

Microsoft Dynamics 365 Supply Chain Management 10.0.16 includes platform updates. To learn more, see

Platform updates for version 10.0.16 of Finance and Operations apps (February 2021).

For information about the bug fixes included in each of the updates that are part of 10.0.16, sign in to Lifecycle

Services (LCS) and view the KB article

Wondering about upcoming and recently released capabilities in any of our business apps or platform?

Check out the Dynamics 365: 2020 release wave 2 plan. We've captured all the details, end to end, top to

bottom, in a single document that you can use for planning.

The Removed or deprecated features in Dynamics 365 Supply Chain Management topic describes features that

have been or are scheduled to be removed or deprecated for Supply Chain Management.

A removed feature is no longer available in the product.

A deprecated feature is not in active development and may be removed in a future update.

Before any feature is removed from the product, the deprecation notice will be announced in the Removed or

deprecated features in Dynamics 365 Supply Chain Management topic 12 months prior to the removal.

For breaking changes that only affect compilation time, but are binary compatible with sandbox and production

environments, the deprecation time will be less than 12 months. Typically, these are functional updates that need

to be made to the compiler.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/get-started/whats-new-platform-updates-10-0-16
https://fix.lcs.dynamics.com/Issue/Details?bugId=528995&dbType=3&qc=267a545fabd24e111868bedc16716f5713a785ed096cdb6209526f41631e41db
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave2/index


NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Features included in this release

Additional resources
Platform updates for Finance and Operations appsPlatform updates for Finance and Operations apps

This topic lists features that are either new or changed in Microsoft Dynamics 365 Supply Chain Management

version 10.0.15. This version has a build number of 10.0.644 and is available as follows:

Preview of release:Preview of release: October 2020

General availability of release (self-update):General availability of release (self-update): November 2020

General availability of release (auto-update):General availability of release (auto-update): January 2021

The following features are included in this release. Some of the listed features are still in preview, while others

may already be generally available. Follow the links to the release plan to see the official release dates for each

feature.

Cloud and edge scale unit management with manufacturing and warehouse execution workloads

- For more information, see Cloud and edge scale units for manufacturing and warehouse management

workloads.

Create and process transfer orders from the warehouse app

- For more information, see Create transfer orders from the warehouse app.

Default RFQ reply fields for vendor bidding

- For more information, see Requests for quotation (RFQs) overview.

Engineering Change Management Add-in for Dynamics 365 Supply Chain Management

- For more information, see Engineering change management overview.

Mixed-reality Guides for manufacturing

- For more information, see Provide mixed-reality Guides for workers in production.

New user experience for production floor execution

- For more information, see How workers use the production floor execution interface.

Process warehouse app events

- For more information, see Warehouse app event processing.

Saved views for the Released products page

- For more information, see Saved views.

USMCA certification of origin document

- For more information, see USMCA certification of origin.

Most of these features must be enabled using Feature management before you can use them.

Microsoft Dynamics 365 Supply Chain Management 10.0.15 includes platform updates. To learn more, see

Platform updates for version 10.0.15 of Finance and Operations apps (October 2020).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/get-started/whats-new-scm-10-0-15.md
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave2/finance-operations/dynamics365-supply-chain-management/planned-features
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave2/finance-operations/dynamics365-supply-chain-management/ad-hoc-transfer-order-creation-warehousing-mobile-app
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave2/finance-operations/dynamics365-supply-chain-management/default-rfq-reply-fields-for-vendor-bidding
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave2/finance-operations/dynamics365-supply-chain-management/engineering-change-management
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave2/finance-operations/dynamics365-supply-chain-management/mixed-reality-guides-manufacturing
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave2/finance-operations/dynamics365-supply-chain-management/mes-terminal-enhancements-discrete-manufacturing
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave2/finance-operations/dynamics365-supply-chain-management/process-warehouse-app-events
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave2/finance-operations/dynamics365-supply-chain-management/saved-views-released-products-page
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/get-started/whats-new-platform-updates-10-0-15


Bug fixesBug fixes

Dynamics 365: 2020 release wave 2 planDynamics 365: 2020 release wave 2 plan

Removed and deprecated Supply Chain Management featuresRemoved and deprecated Supply Chain Management features

NOTENOTE

For information about the bug fixes included in each of the updates that are part of 10.0.15, sign in to Lifecycle

Services (LCS) and view the KB article.

Wondering about upcoming and recently released capabilities in any of our business apps or platform?

Check out the Dynamics 365: 2020 release wave 2 plan. We've captured all the details, end to end, top to

bottom, in a single document that you can use for planning.

The Removed or deprecated features in Dynamics 365 Supply Chain Management topic describes features that

have been or are scheduled to be removed or deprecated for Supply Chain Management.

A removed feature is no longer available in the product.

A deprecated feature is not in active development and may be removed in a future update.

Before any feature is removed from the product, the deprecation notice will be announced in the Removed or

deprecated features in Dynamics 365 Supply Chain Management topic 12 months prior to the removal.

For breaking changes that only affect compilation time, but are binary compatible with sandbox and production

environments, the deprecation time will be less than 12 months. Typically, these are functional updates that need

to be made to the compiler.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://fix.lcs.dynamics.com/Issue/Details?bugId=514518&dbType=3&qc=8fbe12733a7e1aa197e91fb11530f69fa89b9b39c08d89a19873f755c9430988
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave2/index
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

Features removed or deprecated in the Supply Chain Management
10.0.15 release
Internet Explorer 11 support for Dynamics 365 is deprecatedInternet Explorer 11 support for Dynamics 365 is deprecated

Reason for deprecation/removalReason for deprecation/removal Effective December 2020, Microsoft Internet Explorer 11
support for all Dynamics 365 products is deprecated, and
Internet Explorer 11 won’t be supported after August 2021.

This will impact customers who use Dynamics 365 products
that are designed to be used through an Internet Explorer
11 interface. After August 2021, Internet Explorer 11 won't
be supported for such Dynamics 365 products.

Replaced by another feature?Replaced by another feature? We recommend that customers transition to Microsoft Edge.

Product areas affectedProduct areas affected All Dynamics 365 products

Deployment optionDeployment option All

StatusStatus Deprecated. Internet Explorer 11 won’t be supported after
August 2021.

Use of built-in Supply Chain Management master planning engine for manufacturing scenariosUse of built-in Supply Chain Management master planning engine for manufacturing scenarios

This topic will be updated as new removed or deprecated features are documented for Dynamics 365 Supply

Chain Management.

A removed feature is no longer available in the product.

A deprecated feature is not in active development and may be removed in a future update.

This list is intended to help you consider these removals and deprecations for your own planning.

Detailed information about objects in Finance and Operations apps can be found in the Technical reference reports. You

can compare the different versions of these reports to learn about objects that have changed or been removed in each

version of Finance and Operations apps.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/get-started/removed-deprecated-features-scm-updates.md
https://docs.microsoft.com/en-us/dynamics/s-e/


Reason for deprecation/removalReason for deprecation/removal To enhance performance and minimize the SQL database
load during master planning runs, the built-in Supply Chain
Management master planning engine is being replaced by
Planning Optimization. Planning Optimization allows for fast
planning runs that can be performed even during office
hours. This enables planners to react immediately to changes
in demand or planning parameters.

Replaced by another feature?Replaced by another feature? Yes, Planning Optimization will replace the existing built-in
Supply Chain Management master planning engine.

Product areas affectedProduct areas affected Supply Chain Management - Master planning

Deployment optionDeployment option Cloud only. Planning Optimization is not supported with on-
premises deployments.

StatusStatus Deprecated. By October 1, 2021, manufacturing scenarios
will no longer be supported with the built-in Dynamics 365
Supply Chain Management master planning engine. For
manufacturing scenarios, customers must use Planning
Optimization for master planning calculations. For more
information, see Planning Optimization documentation.
Customers with on-premises deployments of Dynamics 365
Supply Chain Management may continue to use the Supply
Chain Management master planning engine for
manufacturing scenarios after October 2021. However, no
more feature enhancements will be provided.

Features removed or deprecated in the Supply Chain Management
10.0.11 release
Use of built-in Supply Chain Management master planning engine for distribution scenariosUse of built-in Supply Chain Management master planning engine for distribution scenarios

Reason for deprecation/removalReason for deprecation/removal To enhance performance and minimize the SQL database
load during master planning runs, the built-in Supply Chain
Management master planning engine is being replaced by
Planning Optimization. Planning Optimization allows for fast
planning runs that can be performed even during office
hours. This enables planners to react immediately to changes
in demand or planning parameters.

Replaced by another feature?Replaced by another feature? Yes, Planning Optimization will replace the existing built-in
Supply Chain Management master planning engine.

Product areas affectedProduct areas affected Supply Chain Management - Master planning

Deployment optionDeployment option Cloud only. Planning Optimization is not supported with on-
premises deployments.

https://go.microsoft.com/fwlink/?linkid=2105830


StatusStatus Deprecated. By April 1, 2021, distribution scenarios will no
longer be supported with the built-in Dynamics 365 Supply
Chain Management master planning engine. For distribution
scenarios, customers must use Planning Optimization for
master planning calculations. For more information, see
Planning Optimization documentation. Customers with on-
premises deployments of Dynamics 365 Supply Chain
Management may continue to use the Supply Chain
Management master planning engine for distribution
scenarios after April 2021. However, no more feature
enhancements will be provided.

Previous announcements about removed or deprecated features

NOTENOTE

To learn more about features that have been removed or deprecated in previous releases, see Removed or

deprecated features in previous releases.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://go.microsoft.com/fwlink/?linkid=2105830
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

IMPORTANTIMPORTANT

Finance 10.0.7 with Platform update 31
Chinese voucher types without Account groups selectionChinese voucher types without Account groups selection

    

Reason for deprecation/removalReason for deprecation/removal Changed to the feature with account groups selection.

Replaced by another feature?Replaced by another feature? Yes

Product areas affectedProduct areas affected Application

Deployment optionDeployment option All

StatusStatus Deprecated: By December 1, 2020, we plan to no longer
support Chinese voucher types setup without Account
groups selection. Find more details about new feature design
in What's new in 10.0.7

Effective November 2020:

Common Data Service has been renamed to Microsoft Dataverse. For more information, see Power Automate Blog.

Some terminology in Microsoft Dataverse has been updated. For example, entity is now table and field is now column.

For more information, see Terminology updates.

This topic will be updated soon to reflect the latest terminology.

This topic is no longer updated. To see a current list of features that have been removed or deprecated from Finance and

Operations apps, search for "Removed or deprecated features""Removed or deprecated features" content that relates to the app you're using.

This topic describes features that have been removed or deprecated from Dynamics 365 for Finance and

Operations and previous releases of that product.

A removed feature is no longer available in the product.

A deprecated feature is not in active development and may be removed in a future update.

This list is intended to help you consider these removals and deprecations for your own planning.

Detailed information about objects in Finance and Operations apps can be found in the Technical reference

reports. You can compare the different versions of these reports to learn about objects that have changed or

been removed in each version of Finance and Operations apps.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/migration-upgrade/deprecated-features.md
https://aka.ms/PAuAppBlog
https://go.microsoft.com/fwlink/?linkid=2147247
https://docs.microsoft.com/en-us/dynamics/s-e/global/axtechrefrep_61


Finance and Operations 10.0.6 with Platform update 30
DimensionHash.getHash(str _message)DimensionHash.getHash(str _message)

    

Reason for deprecation/removalReason for deprecation/removal Windows is deprecating the use of SHA1, as documented in
Windows Enforcement of SHA1 Certificates.

Replaced by another feature?Replaced by another feature? Yes

Product areas affectedProduct areas affected Application

Deployment optionDeployment option All

StatusStatus Deprecated: By April 1, 2020, developers must use the
platform APIs found in the class HasFunctionHasFunction.

Hash.ComputeSHA1Hash(string message)Hash.ComputeSHA1Hash(string message)

    

Reason for deprecation/removalReason for deprecation/removal Windows is deprecating the use of SHA1, as documented in
Windows Enforcement of SHA1 Certificates.

Replaced by another feature?Replaced by another feature? Yes

Product areas affectedProduct areas affected Platform

Deployment optionDeployment option All

StatusStatus Deprecated: By April 1, 2020, developers must use the
platform APIs found in the class HasFunctionHasFunction.

FormDateTimeControl.setUtcString()FormDateTimeControl.setUtcString()

    

Reason for deprecation/removalReason for deprecation/removal We are retiring the setUtcString()setUtcString() method, because a
better replacement method is available.

Replaced by another feature?Replaced by another feature? Yes

Product areas affectedProduct areas affected Platform

Deployment optionDeployment option All

StatusStatus Deprecated: By October 1, 2020, we plan to no longer
support the setUtcString()setUtcString() method. Developers should be
using the setUtcDateTime()setUtcDateTime() method instead.

Blacklist report (IT) – Feature reference IT-00001Blacklist report (IT) – Feature reference IT-00001

https://social.technet.microsoft.com/wiki/contents/articles/32288.windows-enforcement-of-sha1-certificates.aspx
https://social.technet.microsoft.com/wiki/contents/articles/32288.windows-enforcement-of-sha1-certificates.aspx


    

Reason for deprecation/removalReason for deprecation/removal Not legally required.

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Italian localization

Deployment optionDeployment option All

StatusStatus Deprecated: By October 1, 2020, we plan to no longer
support the Blacklist repor t (IT) – Feature referenceBlacklist repor t (IT) – Feature reference
IT-00001IT-00001 .

Domestic tax report – Feature reference IT-00003Domestic tax report – Feature reference IT-00003

    

Reason for deprecation/removalReason for deprecation/removal Not legally required.

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Italian localization

Deployment optionDeployment option All

StatusStatus Deprecated: By October 1, 2020, we plan to no longer
support the Domestic tax repor t – Feature referenceDomestic tax repor t – Feature reference
IT-00003IT-00003 .

Finance and Operations 10.0.5 with Platform update 29
US Payroll tax updatesUS Payroll tax updates

    

Reason for deprecation/removalReason for deprecation/removal We are retiring tax updates for the US Payroll functionality
due to low usage and enhanced functionality that is now
offered via strategic integrations.

Replaced by another feature?Replaced by another feature? Yes

Product areas affectedProduct areas affected Payroll

Deployment optionDeployment option All

StatusStatus Deprecated: By July 31, 2024, we plan to no longer provide
tax updates to US Payroll customers. The functionality will
remain in the product, but enhancements will no longer
keep the functionality up to date, and any product defects
will be evaluated on a case-by-case basis.



NOTENOTE

Data management staging clean upData management staging clean up

    

Reason for deprecation/removalReason for deprecation/removal Does not meet the core requirements that are needed for
scheduling periodic cleanup.

Replaced by another feature?Replaced by another feature? Yes, the Job history cleanup feature is being added to meet
the scenarios holistically.

Product areas affectedProduct areas affected Data management

Deployment optionDeployment option All

StatusStatus Deprecated: Target timeframe for the functionality to be
removed is December 2020.

Finance and Operations 10.0.4 with Platform update 28
France: FEC Accounting data export in XMLFrance: FEC Accounting data export in XML

    

Reason for deprecation/removalReason for deprecation/removal Replaced by TXT format, French FEC audit fileFrench FEC audit file is available
through General ledgerGeneral ledger  > Periodic tasksPeriodic tasks > DataData
expor texpor t .

Replaced by another feature?Replaced by another feature? Yes

Product areas affectedProduct areas affected General ledger

Deployment optionDeployment option All

StatusStatus Deprecated. Target timeframe for the functionality to be
removed is July 2020.

Legacy navigation barLegacy navigation bar

    

Reason for deprecation/removalReason for deprecation/removal Header alignment with other Dynamics and Office products.
For more details, see Updated navigation bar that aligns
with the Office header.

Replaced by another feature?Replaced by another feature? Starting in Platform update 24, a restyled navigation bar
that features search was introduced.

Product areas affectedProduct areas affected Web client

This represents a change from the original discontinuation date of October 1, 2021. For more information, see Tax

updates being retired for US Payroll feature in Microsoft Dynamics 365 for Finance and Operations.

https://aka.ms/financepayrollfaq
https://docs.microsoft.com/en-us/business-applications-release-notes/april19/dynamics365-finance-operations/updatednavbar


Deployment optionDeployment option All

StatusStatus Deprecated: Starting in April 2020, the legacy navigation bar
will no longer be available. Until that point, customers can
revert to the legacy navigation bar through the ClientClient
performance optionsperformance options page.

    

Finance and Operations 10.0.2 with Platform update 26
Legacy default action behaviorLegacy default action behavior

    

Reason for deprecation/removalReason for deprecation/removal The legacy behavior for default actions in grids results in an
unexpected column having the default action link after grid
columns have been reordered via personalization. The new
sticky default action feature corrects this. For more details,
see Sticky default actions in grids.

Replaced by another feature?Replaced by another feature? Starting in Platform update 21, a feature for "sticky default
actions" was introduced. This feature can be enabled on the
Client performance optionsClient performance options page.

Product areas affectedProduct areas affected Grids in the web client

Deployment optionDeployment option All

StatusStatus Deprecated: Starting in April 2020, sticky default actions will
be the default behavior, without a mechanism to revert to
the legacy behavior.

Legacy "is one of" filtering experienceLegacy "is one of" filtering experience

    

Reason for deprecation/removalReason for deprecation/removal The "is one of" filtering experience went through a redesign
in Platform update 22,with the plan for this to eventually be
the only "is one of" filtering experience.

Replaced by another feature?Replaced by another feature? Starting in Platform update 22, an improved "is one of"
filtering experience became available on the ClientClient
performance optionsperformance options page. For more information, see
Optimized is one of filtering experience.

Product areas affectedProduct areas affected Web client

Deployment optionDeployment option All

StatusStatus Deprecated: Starting in April 2020, the improved "is one of"
experience will be the default behavior, without a mechanism
to revert to the legacy behavior.

Parameter to enable sales orders with multiple project contract funding sourcesParameter to enable sales orders with multiple project contract funding sources
Support for creating project-based sales orders where the project contract has multiple funding sources is

https://docs.microsoft.com/en-us/business-applications-release-notes/october18/dynamics365-finance-operations/sticky-default-action
https://docs.microsoft.com/en-us/business-applications-release-notes/october18/dynamics365-finance-operations/improved-isoneof-filtering


    

Reason for deprecation/removalReason for deprecation/removal The functionality will always be enabled after the parameter
is removed.

Replaced by another feature?Replaced by another feature? No. The functionality to support project-based sales orders
with multiple funding sources will always be enabled.

Product areas affectedProduct areas affected The Allow sales orders for projects with multipleAllow sales orders for projects with multiple
funding sourcesfunding sources parameter will be removed. The following
methods will be modified when the parameter is removed:
ctrlSalesOrderTablectrlSalesOrderTable method in ProjStatusTypeProjStatusType class,
validatevalidate method for ProjIdProjId field, and runrun method in
SalescreateOrderSalescreateOrder  form. The following methods will be
deprecated when the parameter is removed:
IsSalesOrderAllowedForMultipleFundingSourcesIsSalesOrderAllowedForMultipleFundingSources in
ProjTableProjTable table file,
IsAllowSalesOrdersForMultipleFundingSourcesParamIsAllowSalesOrdersForMultipleFundingSourcesParam
EnabledEnabled method in ProjTableProjTable table file,
AllowSalesOrdersForMultipleFundingSourcesAllowSalesOrdersForMultipleFundingSources data
field in ProjParametersProjParameters  form and ProjParameterEntityProjParameterEntity
files, IsAssociatedToMultipleFundingSourcesContractIsAssociatedToMultipleFundingSourcesContract
private method in ProjTableProjTable table file.

Deployment optionDeployment option All

StatusStatus Deprecation is planned for the April 2020 release wave.

Legacy workflow reports for tracking and instance statusLegacy workflow reports for tracking and instance status

    

Reason for deprecation/removalReason for deprecation/removal The legacy workflow reports for tracking and instance status
are being deprecated because they are no longer referenced
from the navigation. The report names are
WorkflowWorkflowInstanceByStatusReport and
WorkflowWorkflowTrackingReport.

Replaced by another feature?Replaced by another feature? The workflow history form can be used instead.

Product areas affectedProduct areas affected Web client

Deployment optionDeployment option All

StatusStatus Deprecated: Target timeframe for the functionality to be
removed is April 2020.

Finance and Operations 10.0.1 with Platform update 25
Deprecated APIs and potential breaking changesDeprecated APIs and potential breaking changes
Deriving from internal classes is deprecatedDeriving from internal classes is deprecated

enabled with the Project management parametersProject management parameters  setting Allow sales orders for project with multipleAllow sales orders for project with multiple

funding sourcesfunding sources . By default, this parameter is not enabled.



 

    

Reason for deprecation/removalReason for deprecation/removal Before Platform update 25, it was possible to create a class
or table that derives from an internal class/table that is
defined in another package/module. This is not a safe coding
practice. As of Platform update 25, the compiler will display a
warning.

Replaced by another feature?Replaced by another feature? The compiler warning will be replaced by an error in Platform
update 26. This change is backward compatible at runtime,
which means that Platform update 25 or newer can be
deployed on any sandbox or production environment
without the need to modify custom code. This change only
affects development and compile time.

Product areas affectedProduct areas affected Visual Studio development tools

Deployment optionDeployment option All

StatusStatus Deprecated: The warning will become a compilation error in
Platform update 26.

Overriding internal methods is deprecatedOverriding internal methods is deprecated

    

Reason for deprecation/removalReason for deprecation/removal Before Platform update 25, it was possible to override an
internal method in a derived class that is defined in another
package/module. This is not a safe coding practice. As of
Platform update 25, the compiler will display a warning.

Replaced by another feature?Replaced by another feature? This warning will be replaced by a compile error in Platform
update 26. This change is backward compatible at runtime,
which means that Platform update 25 or newer can be
deployed on any sandbox or production environment
without the need to modify custom code. This change only
affects development and compile time.

Product areas affectedProduct areas affected Visual Studio development tools

Deployment optionDeployment option All

StatusStatus Deprecated: The warning will become a compilation error in
Platform update 26.

Finance and Operations 10.0.0 with Platform update 24
Renaming released productsRenaming released products

    

Reason for deprecation/removalReason for deprecation/removal When you use the Rename primar y keyRename primar y key  function to
change the ItemId of a released product, only direct foreign
key references are updated. Any other references to the
released product, such as from production orders, will retain
the old ItemId. As a result, there could be inconsistent data
that will eventually block business processes.



Replaced by another feature?Replaced by another feature? No.

Product areas affectedProduct areas affected Product information management

Deployment optionDeployment option All

StatusStatus Removed as of Finance and Operations 10.0.0 with Platform
update 24.

    

Finance and Operations 8.1.3 with Platform update 23
SQL Server Reporting Services ReportViewer ControlSQL Server Reporting Services ReportViewer Control

    

Reason for deprecation/removalReason for deprecation/removal The non-paginated nature of the HTML-based preview
experience does notnot  deliver fidelity with the physical
documents ultimately produced by Finance and Operations.
By fully embracing PDF as the standard format for business
documents, users are able to take advantage of a modern
viewing experience with improved performance when
producing application reports.

Replaced by another feature?Replaced by another feature? Going forward, PDF documents will be the default format for
reports rendered by Finance and Operations.

Product areas affectedProduct areas affected This change does notnot  impact customer scenarios where
reports are distributed electronically or sent directly to
printers.

Deployment optionDeployment option All

StatusStatus Deprecated: A removal date has not been set for this
feature. The functionality to automatically preview
application reports using an embedded PDF viewer is
planned for the May 2019 Platform update.

Client KPI controlsClient KPI controls

    

Reason for deprecation/removalReason for deprecation/removal The native client controls used to define KPIs have low
customer uptake and rely on a developer to add trackable
metrics.

Customers can use the Expor tExpor t action provided by the embedded SQL Server Reporting Services (SSRS)

ReportViewer control to download documents produced by Finance and Operations applications. This HTML-

based presentation of the report offers users a non-paginated preview of the document.

Embedded key performance indicators (KPIs) could be modeled in Visual Studio by a developer and further

customized by the end user.



Replaced by another feature?Replaced by another feature? PowerBI.com service delivers world-class tooling for defining
and managing KPIs based on data from external sources. In
an upcoming release, we plan to enable you to embed
solutions hosted on PowerBI.com in application workspaces.

Product areas affectedProduct areas affected This update will prevent developers from introducing new
KPI controls in Visual Studio designer.

Deployment optionDeployment option All

StatusStatus Deprecated: A removal date has not been set for this
feature.

    

Deprecated APIs and future breaking changesDeprecated APIs and future breaking changes
Field groups containing invalid field referencesField groups containing invalid field references

    

Reason for deprecation/removalReason for deprecation/removal It is possible for table metadata definitions to have field
groups containing invalid field references. If deployed, this
can cause runtime failures in Financial Reporting and SQL
Server Reporting Services (SSRS). This issue is currently
categorized as a compiler warning rather than an error,
meaning that the deployable package creation and
deployment can proceed without fixing the issue. To fix this
issue:

1. Remove the invalid field reference from the table field
group definition.

2. Recompile.

3. Ensure any warnings or errors are addressed.

Replaced by another feature?Replaced by another feature? This warning will be replaced by a compile error in the future.

Product areas affectedProduct areas affected Visual Studio development tools

Deployment optionDeployment option All

StatusStatus Deprecated: The warning is a compile-time error with
platform updates for version 10.0.11 of Finance and
Operations apps.

Complete listComplete list

Finance and Operations 8.1 with Platform update 20
Batch transfer rules for subledger journal account entriesBatch transfer rules for subledger journal account entries

To access the full list of APIs that are being deprecated, see Deprecation of methods and metadata elements.

The Synchronous transfer mode is being deprecated in the General ledger parameters. This mode is replaced by

Asynchronous and scheduled batch only, which already exist as options for transfer. For additional information,

see the General Ledger Parameters – Batch transfer rules blog.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/migration-upgrade/deprecation-deletion-apis
https://community.dynamics.com/365/financeandoperations/b/financials/archive/2019/03/15/general-ledger-parameters-batch-transfer-rules


    

Reason for deprecation/removalReason for deprecation/removal We are removing the synchronous option due to
performance impact to the system.

Replaced by another feature?Replaced by another feature? Asynchronous and scheduled batch are options to use in
place of Synchronous.

Product areas affectedProduct areas affected General Ledger, Accounts payable, Accounts Receivable,
Procurement, Expense

Deployment optionDeployment option All

StatusStatus Deprecated: Target timeframe for the functionality to be
removed is the 10.0 version.

Electronic reporting for RussiaElectronic reporting for Russia

    

Reason for deprecation/removalReason for deprecation/removal Replaced with Electronic reporting.

Replaced by another feature?Replaced by another feature? Yes.

Product areas affectedProduct areas affected General Ledger

Deployment optionDeployment option All

StatusStatus Removed as of Finance and Operations 8.1 with Platform
update 20.

Financial reports generator for RussiaFinancial reports generator for Russia

    

Reason for deprecation/removalReason for deprecation/removal Removed parts are replaced with Electronic reporting.

Replaced by another feature?Replaced by another feature? Yes. Financial reports setup user interface should be used for
setting up data collection rules by GL accounts or tax
registers. Export data to various file types, fixed requisites
and query-like data collection rules should be configured in
Electronic reporting.

Product areas affectedProduct areas affected General ledger.

Deployment optionDeployment option All

StatusStatus Removed as of Finance and Operations 8.1 with Platform
update 20.

Integration with external providers for sending electronic reporting through communication channels forIntegration with external providers for sending electronic reporting through communication channels for

Feature for configuring .txt and .xml file formats of declarations.

A tool for setting up data collection for accounting and tax reports, and to export data to XLS and DOC report

templates. Functional parts: Export data to XLS and DOC report templates, queries, fixed requisites are removed.



RussiaRussia

    

Reason for deprecation/removalReason for deprecation/removal Replaced with electronic messages configurable feature.

Replaced by another feature?Replaced by another feature? Yes.

Product areas affectedProduct areas affected General Ledger, Tax

Deployment optionDeployment option All

StatusStatus Removed as of Finance and Operations 8.1 with Platform
update 20.

Profit tax register wizardProfit tax register wizard

    

Reason for deprecation/removalReason for deprecation/removal Feature is not compatible with the Finance and Operations
extensibility model.

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Tax

Deployment optionDeployment option All

StatusStatus Removed as of Finance and Operations 8.1 with Platform
update 20.

Finance and Operations 8.0 with Platform update 15

Finance and Operations, Enterprise edition 7.3 with Platform update
12
Personalized product recommendationsPersonalized product recommendations

    

Reason for deprecation/removalReason for deprecation/removal We are removing the current version of the product
recommendation service as we redesign this feature with a
better algorithm and newer retail-oriented capabilities.

Feature exporting generated electronic files of declarations to folder for further sending to official providers of

electronic reporting as well as importing state back.

Feature for creating templates for new profit tax registers. This feature creates X++ objects for new registers,

which are then created as templates with the appropriate calculation logic added in.

No features have been removed or deprecated with this release. Platform update 15 is cumulative and contains

new or changed features from Platform update 13, Platform update 14, and Platform update 15.

Starting February 15, 2018, retailers will no longer be able to display personalized product recommendations

on a point of sale (POS) device. For more information, see Product recommendations overview.

https://docs.microsoft.com/en-us/dynamics365/commerce/product-recommendations


Replaced by another feature?Replaced by another feature? No. However, after Spring 2018, we plan to bring back this
feature to leverage a new recommendation service.

Product areas affectedProduct areas affected Personalized product recommendations in POS.

Deployment optionDeployment option All

StatusStatus Removed as of February 15, 2018. This affects customers
running Dynamics 365 for Operations 1611 and later.

    

Extension of the list of Electronic reporting (ER) functionsExtension of the list of Electronic reporting (ER) functions

    

Reason for deprecation/removalReason for deprecation/removal Code sealing initiative

Replaced by another feature?Replaced by another feature? None. Whenever a new built-in function is needed, a new
extension request must be addressed to the ER framework
team.

As a temporary work around while the requested function is
under development by the ER team, the required logic can
be programmed as a method of a custom application class.
This method can be accessed in an ER expression as a
property of the added ER data source of the
Application\ClassApplication\Class  type that refers to that custom
application class.

Product areas affectedProduct areas affected Electronic reporting framework

Deployment optionDeployment option All

StatusStatus Removed as of Finance and Operations, Enterprise edition
7.3.

Inventory by item group and Inventory by inventory dimension aging reportsInventory by item group and Inventory by inventory dimension aging reports

    

Reason for deprecationReason for deprecation Duplicate functionality

Replaced by another feature?Replaced by another feature? Yes. The two reports have been replaced by the Inventor yInventor y
agingaging report.

Product areas affectedProduct areas affected Inventory management, Cost management

The possibility to introduce custom functions to be used in the ER expression builder (for more information, see

Extend the list of Electronic reporting (ER) functions) is not supported any more. Due to changes of the ER APIs,

the API to call built-in functions from the ER expression builder became internal and can’t be extended any

longer.

These two reports are no longer supported in Finance and Operations. Instead, the Inventor y agingInventor y aging report can

be used to improve the user experience.



      

Deployment optionDeployment option All

StatusStatus Deprecated: The menu items for the two reports have been
removed in version 7.3. However, the code for the reports
remains in the product. The plan is to remove the code in a
future release.

    

Power BI content packs available on AppSourcePower BI content packs available on AppSource

    

Reason for deprecation/removalReason for deprecation/removal Product updates in Microsoft Power BI.

Replaced by another feature?Replaced by another feature? The Cost managementCost management , Financial performanceFinancial performance, and
Retail channel performanceRetail channel performance content packs, available on
the AppSource site, are being replaced by analytical
applications which allow for solution integrations at the
database level. For more information about analytical
applications, see Embedded Power BI in workspaces.

Product areas affectedProduct areas affected Cost management, Finance, and Retail

Deployment optionDeployment option Cloud only (Integration with PowerBI.com is not supported
in on-premises deployments.)

StatusStatus Deprecated: Target timeframe for the functionality removal is
Q2 2018.

Standard UI in data management workspaceStandard UI in data management workspace

    

Reason for deprecation/removalReason for deprecation/removal We are investing in providing new user experiences in the
new UI.

Replaced by another feature?Replaced by another feature? The new UI called Enhanced views is replacing the old UI.

Product areas affectedProduct areas affected Data management workspace

Deployment optionDeployment option All

StatusStatus Deprecated: Target timeframe for the functionality to be
removed is Q2 2018.

Excise, Sales Tax, Service Tax for IndiaExcise, Sales Tax, Service Tax for India

The Cost managementCost management, Financial performanceFinancial performance, and Retail channel performanceRetail channel performance content packs, available

on the Microsoft AppSource site, are deprecated as a consequence of product updates in Microsoft Power BI.

System administration forms used to deploy these content packs to PowerBI.com are also being deprecated in

Finance and Operations.

The standard UI in data management is the legacy UI, which is the default UI presented to the users when they

visit the data management workspace.

These taxes have been subsumed into Indian GST.

https://appsource.microsoft.com
https://appsource.microsoft.com


    

Reason for removal or deprecationReason for removal or deprecation These taxes have been subsumed into Indian GST.

Replaced by another feature?Replaced by another feature? Indian GST

Product areas affectedProduct areas affected Tax

Deployment optionDeployment option All modules

StatusStatus Deprecated: A removal date has not been set for this
feature.

File Validation Utility (FVU) for IndiaFile Validation Utility (FVU) for India

    

Reason for removal or deprecationReason for removal or deprecation Lack of customer usage

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Indian withholding tax

Deployment optionDeployment option All modules

StatusStatus Deprecated: A removal date has not been set for this
feature.

TDS/TCS certificate for IndiaTDS/TCS certificate for India

    

Reason for removal or deprecationReason for removal or deprecation Lack of customer usage

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Indian withholding tax

Deployment optionDeployment option All modules

StatusStatus Deprecated: A removal date has not been set for this
feature.

Export/import (EXIM) incentive scheme for IndiaExport/import (EXIM) incentive scheme for India

    

Reason for removal or deprecationReason for removal or deprecation Lack of customer usage

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Import and export

Users can download this from the government portal.



Deployment optionDeployment option All modules

StatusStatus Deprecated: A removal date has not been set for this
feature.

    

Dynamics 365 for Retail 7.2
Personalized product recommendationsPersonalized product recommendations

    

Reason for deprecation/removalReason for deprecation/removal We are removing the current version of the product
recommendation service as we redesign this feature with a
better algorithm and newer retail-oriented capabilities.

Replaced by another feature?Replaced by another feature? No. However, after Spring 2018, we plan to bring back this
feature to leverage a new recommendation service.

Product areas affectedProduct areas affected Personalized product recommendations in POS.

Deployment optionDeployment option All

StatusStatus Removed as of February 15, 2018. This affects customers
running Dynamics 365 for Retail 7.2 and later.

Finance and Operations, Enterprise edition July 2017 with Platform
update 8
Currency conversion for accounting and reporting currenciesCurrency conversion for accounting and reporting currencies

    

Reason for deprecation/removalReason for deprecation/removal Limited usage and addition of the Copy legal entity
functionality as a replacement.

Replaced by another feature?Replaced by another feature? No, but the Copy legal entity and Configurations features
were added to make it easier to move to a company that
has changing core requirements.

Product areas affectedProduct areas affected Financial management

StatusStatus Deprecated: A removal date has not been set for this
feature.

Warehouse mobile devices portalWarehouse mobile devices portal

Starting February 15, 2018, retailers will no longer be able to display personalized product recommendations

on a point of sale (POS) device. For more information, see Product recommendations overview.

Currency conversion for accounting and reporting currencies was introduced when the euro was introduced.

Warehouse mobile devices portal (WMDP) was a standalone component that was intended for on-premises self-

deployment. This component is no longer supported in Finance and Operations. A native app that improves the

user experience has replaced the functionality of WMDP.

https://docs.microsoft.com/en-us/dynamics365/commerce/product-recommendations


    

Reason for deprecation/removalReason for deprecation/removal Duplicate functionality.

Replaced by another feature?Replaced by another feature? Yes. This feature has been replaced by Finance and
Operations - Warehousing. For more information about
setup and prerequisites, see Install and configure the
Warehousing app overview.

Product areas affectedProduct areas affected Warehouse management, Transportation management

Deployment optionDeployment option Warehouse mobile devices portal (WMDP) was a standalone
component that was intended for on-premises self-
deployment.

StatusStatus Deprecated: Target timeframe for the functionality to be
removed is Q4 2019.

Advanced bank reconciliation matching rule for manual matchingAdvanced bank reconciliation matching rule for manual matching

    

Reason for deprecation/removalReason for deprecation/removal Limited usage.

Replaced by another feature?Replaced by another feature? No. Column filtering capabilities should be used to find
documents for reconciliation.

Product areas affectedProduct areas affected Cash and bank management

Deployment optionDeployment option All

StatusStatus Removed as of July 2017.

Dynamics 365 for Operations 1611 with Platform update 3
AEB payment formats for SpainAEB payment formats for Spain

    

Reason for deprecation/removalReason for deprecation/removal The payment formats are no longer used.

Replaced by another feature?Replaced by another feature? Yes, ISO20022 Credit transfer and Direct debit payment
formats for Spain

Product areas affectedProduct areas affected Accounts payable, Accounts receivable

A matching rule was used to select and mark a bank document when documents were manually matched in the

reconciliation worksheet.

The Consejo Superior Bancario payment formats were used to send remittance files to the bank for customer

payments and vendor payments. The content of these formats was determined by the Asociación Española de

Banca. It covers Cuaderno 19, 32, 58, 34.



StatusStatus Deprecated: A removal date has not been set for this
feature.

    

Bank payments transfer for LithuaniaBank payments transfer for Lithuania

    

Reason for deprecation/removalReason for deprecation/removal The payment formats are no longer used.

Replaced by another feature?Replaced by another feature? Yes, ISO20022 Credit transfer payment format for Lithuania

Product areas affectedProduct areas affected Accounts payable

StatusStatus Deprecated: A removal date has not been set for this
feature.

BBS Direkte Remittering payment formats for NorwayBBS Direkte Remittering payment formats for Norway

    

Reason for deprecation/removalReason for deprecation/removal The payment formats are no longer used.

Replaced by another feature?Replaced by another feature? The AvtaleGiro customer payment format for Norway can be
used to generate direct debit messages. Return message
import will be implemented in future releases.

Product areas affectedProduct areas affected Accounts payable, Accounts receivable

StatusStatus Deprecated: A removal date has not been set for this
feature.

Chart of Accounts tool for SpainChart of Accounts tool for Spain

    

Reason for deprecation/removalReason for deprecation/removal Limited usage

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected General ledger

StatusStatus Deprecated: A removal date has not been set for this
feature.

Dom80 payment format for BelgiumDom80 payment format for Belgium

Bank payment transfers were generated and printed by using the Payment transfer (LT) export format for

Lithuania. The Lithuanian market began to use LITAS, the unified electronic banking system, in 2005.

BBS Direkte Remittering payment formats include customer payment collection export (direct debit) and return

message import.

This tool is used when a chart of accounts in Spain requires major changes. Users can import a new chart of

accounts in Microsoft Excel or text format, and can also import financial statements.



    

Reason for deprecation/removalReason for deprecation/removal The payment format is no longer used.

Replaced by another feature?Replaced by another feature? Yes, ISO 20022 Direct debit payment format for Belgium

Product areas affectedProduct areas affected Accounts receivable

StatusStatus Deprecated: A removal date has not been set for this
feature.

DTA/EZAG payment formats for SwitzerlandDTA/EZAG payment formats for Switzerland

    

Reason for deprecation/removalReason for deprecation/removal The payment formats are no longer used.

Replaced by another feature?Replaced by another feature? Yes, ISO20022 Credit transfer payment format for
Switzerland

Product areas affectedProduct areas affected Accounts payable

StatusStatus Deprecated: A removal date has not been set for this
feature.

EDIFACT-DIRDEB payment format for AustriaEDIFACT-DIRDEB payment format for Austria

    

Reason for deprecation/removalReason for deprecation/removal The payment format is no longer used.

Replaced by another feature?Replaced by another feature? Yes, ISO 20022 Direct debit payment format for Austria

Product areas affectedProduct areas affected Accounts receivable

StatusStatus Deprecated: A removal date has not been set for this
feature.

EDIVAT for BelgiumEDIVAT for Belgium

    

Reason for deprecation/removalReason for deprecation/removal The functionality is no longer used.

Replaced by another feature?Replaced by another feature? No

Legacy Belgian payment format for payment collection (direct debit).

DTA/EZAG formats are integrated into the ESR system, because they can carry on the reference number. Because

the reference number isn’t mandatory, these formats can be used to process any vendor payments. These

formats are used by companies that have a bank account in a location other than “Postfinance.”

EDIFACT-DIRDEB payment format for payment collection (direct debit).

EDIVAT is an obsolete Belgian standard for electronic declaration via secure mail. Dynamics AX 2012 retains the

read-only solution to enable access to the historical data.



Product areas affectedProduct areas affected General ledger

StatusStatus Deprecated: A removal date has not been set for this
feature.

    

eGiro EDIFACT CREMUL payment import format for NorwayeGiro EDIFACT CREMUL payment import format for Norway

    

Reason for deprecation/removalReason for deprecation/removal The payment format is no longer used.

Replaced by another feature?Replaced by another feature? Yes, the ISO20022 Camt.054 notification import.

Product areas affectedProduct areas affected Accounts receivable

StatusStatus Deprecated: A removal date has not been set for this
feature.

External inventory for PolandExternal inventory for Poland

    

Reason for deprecation/removalReason for deprecation/removal Replaced by another feature

Replaced by another feature?Replaced by another feature? Yes, the core Inbound consignment functionality

Product areas affectedProduct areas affected Accounts payable, Inventory management

StatusStatus Deprecated: A removal date has not been set for this
feature.

Financial reports generator for Eastern EuropeFinancial reports generator for Eastern Europe

    

Reason for deprecation/removalReason for deprecation/removal Limited usage

Replaced by another feature?Replaced by another feature? No. The tool will be replaced by Electronic reporting
configurations in future releases.

Product areas affectedProduct areas affected General Ledger

eGiro is based on the international UN EDIFACT CREMUL (Multiple Credit Advice Message) standard that is used

for automatic posting of customer payments. In Dynamics AX, eGiro is implemented as a customer payment

import format.

Evidence of goods that are taken from a vendor for sales without purchase. Goods that are handled in external

inventory don’t affect standard inventory, and can be sold and then purchased automatically. This process

creates real inventory movements.

A tool is used to set up data collection for accounting and tax reports, and to export data to XLS and DOC report

templates.



StatusStatus Deprecated: A removal date has not been set for this
feature.

    

Import of customer payment transactions for FinlandImport of customer payment transactions for Finland

    

Reason for deprecation/removalReason for deprecation/removal The payment format is no longer used.

Replaced by another feature?Replaced by another feature? Yes, the ISO20022 Camt.054 notification import.

Product areas affectedProduct areas affected Accounts receivable

StatusStatus Deprecated: A removal date has not been set for this
feature.

Import of payment transactions into a general ledger journal for FinlandImport of payment transactions into a general ledger journal for Finland

    

Reason for deprecation/removalReason for deprecation/removal The payment format is no longer used.

Replaced by another feature?Replaced by another feature? Yes, the ISO20022 Camt.053 bank statement import using
Advanced Bank Reconciliation.

Product areas affectedProduct areas affected Accounts receivable

StatusStatus Deprecated: A removal date has not been set for this
feature.

Integration with Isabel synchronized (CIS) for BelgiumIntegration with Isabel synchronized (CIS) for Belgium

    

Reason for deprecation/removalReason for deprecation/removal Integration with Isabel client has been discontinued.

Replaced by another feature?Replaced by another feature? No. The payment formats that are no longer used are
replaced by ISO20022 Credit transfer payment format for
Belgium.

Product areas affectedProduct areas affected Accounts payable

StatusStatus Deprecated: A removal date has not been set for this
feature.

Modifications in the chart of accounts and accounting rules for SpainModifications in the chart of accounts and accounting rules for Spain

You can select an import format for Finnish payments to import customer payment transactions from an

external file that the bank provides.

A format that is specific to Finland is used to import accounting transactions into the general ledger.

Isabel is the framework for electronic banking in Europe and is a de-facto standard in Belgium.

This feature is used for changes in the chart of accounts and accounting rules in Spain. It maps accounts to help



    

Reason for deprecation/removalReason for deprecation/removal Limited usage

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected General ledger

StatusStatus Deprecated: A removal date has not been set for this
feature.

Pagamento Fornittori vendor payment formatPagamento Fornittori vendor payment format

    

Reason for deprecation/removalReason for deprecation/removal The payment format is no longer used.

Replaced by another feature?Replaced by another feature? Yes, ISO20022 Credit transfer payment format for Italy

Product areas affectedProduct areas affected Accounts payable

StatusStatus Deprecated: A removal date has not been set for this
feature.

Payment export formats for EstoniaPayment export formats for Estonia

    

Reason for deprecation/removalReason for deprecation/removal The payment formats are no longer used.

Replaced by another feature?Replaced by another feature? Yes, ISO20022 Credit transfer payment format for Estonia

Product areas affectedProduct areas affected Accounts payable

StatusStatus Deprecated: A removal date has not been set for this
feature.

Payment file archive for NorwayPayment file archive for Norway

    

Reason for deprecation/removalReason for deprecation/removal Replaced by another feature

Replaced by another feature?Replaced by another feature? Yes, Electronic reporting archived jobs

transform the old chart of accounts into the new chart of accounts, and compares the previous fiscal year with

the new fiscal year, even if they were posted to different account numbers.

Legacy Italian payment format for credit transfers.

The Telehansa and Teleservice formats are used for bank payment export.

When payment files are generated, the file archive automatically archives all files that are created, even files that

were previously written or read.



Product areas affectedProduct areas affected Accounts payable, Accounts receivable, Organization
administration

StatusStatus Deprecated: A removal date has not been set for this
feature.

    

Payment import formats for EstoniaPayment import formats for Estonia

    

Reason for deprecation/removalReason for deprecation/removal The payment formats are no longer used.

Replaced by another feature?Replaced by another feature? Yes, the ISO20022 Camt.054 bank notification import.

Product areas affectedProduct areas affected Accounts receivable

StatusStatus Deprecated: A removal date has not been set for this
feature.

Payroll information in Human ResourcesPayroll information in Human Resources

    

Reason for deprecation/removalReason for deprecation/removal This functionality has been replaced by core Payroll and
Human Resources pages.

Replaced by another feature?Replaced by another feature? BenefitsBenefits , EarningsEarnings , and other related pages that were
previously in US Payroll have been reconfigured, and are
now part of the core Human Resources configuration to help
support external payroll processing. This functionality is
accessed by using the Human Resources 1Human Resources 1  > PayrollPayroll
configuration key.

Product areas affectedProduct areas affected Human Resources, Payroll

StatusStatus Removed as of Dynamics 365 for Operations version 1611.

Performance management goal workflowPerformance management goal workflow

    

Reason for deprecation/removalReason for deprecation/removal Performance management was redesigned, and the number
of goal pages was reduced to simplify the process.

Replaced by another feature?Replaced by another feature? No. Goals are visible to managers through the Manager Self
Service portal, and can be changed and viewed by the
manager.

Product areas affectedProduct areas affected Human capital management

The Telehansa and TeleTeenus formats are used for bank payment import.

Human Resources Payroll information

Performance management includes goal management and integration with performance reviews.



StatusStatus Removed as of Dynamics 365 for Operations version 1611.

    

Postgirot and Postgirot Utland payment formats for SwedenPostgirot and Postgirot Utland payment formats for Sweden

    

Reason for deprecation/removalReason for deprecation/removal The payment formats are no longer used.

Replaced by another feature?Replaced by another feature? Yes, ISO20022 Credit transfer payment format for Sweden

Product areas affectedProduct areas affected Accounts payable

StatusStatus Deprecated: A removal date has not been set for this
feature.

Radio frequency identifierRadio frequency identifier

    

Reason for deprecation/removalReason for deprecation/removal Low customer usage and a limited feature set.

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Inventory management

StatusStatus Removed as of Dynamics 365 for Operations 1611.

Report about state invoices numbering for LatviaReport about state invoices numbering for Latvia

    

Reason for deprecation/removalReason for deprecation/removal The state invoice numbering no longer has to be maintained.
The report about used invoice numbers is no longer
required.

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Accounts receivable

StatusStatus Deprecated: A removal date has not been set for this
feature.

Set up the names of the manager and general accountant of a company for LithuaniaSet up the names of the manager and general accountant of a company for Lithuania

Postgirot and Postgirot Utland payment formats for Sweden.

Radio Frequency Identification (RFID) is a data-collection technology that uses electronic tags to store

identification data and a no-line-of-sight requirement reader to capture the identification data.

Latvian legislation provides specific rules about the numbering of sales invoices. The functionality lets you

assign specific numbers to sales invoices, based on the user or user group. You can then generate a report or an

XML file. You can also print a report about invoice numbers that are used.

The names of the manager and the general accountant of a company can be specified in the company



    

Reason for deprecation/removalReason for deprecation/removal Replaced by another feature

Replaced by another feature?Replaced by another feature? Yes, the setup of officials can be used for the same purpose.

Product areas affectedProduct areas affected Accounts payable, Accounts receivable, Cash and bank
management

StatusStatus Deprecated: A removal date has not been set for this
feature.

Shipping carrier interfaceShipping carrier interface

    

Reason for deprecation/removalReason for deprecation/removal Duplicate functionality

Replaced by another feature?Replaced by another feature? Partially replaced by Transportation management

Product areas affectedProduct areas affected Sales and marketing, Inventory management

StatusStatus Removed as of Dynamics 365 for Operations version 1611.

Telepay payment formats for NorwayTelepay payment formats for Norway

    

Reason for deprecation/removalReason for deprecation/removal The payment formats are no longer used.

Replaced by another feature?Replaced by another feature? Yes, ISO20022 Credit transfer payment format and
AvtaleGiro customer payment format for Norway, as well as
pain.002 and camt.054 bank notification return files import.

Product areas affectedProduct areas affected Accounts payable, Accounts receivable

StatusStatus Deprecated: A removal date has not been set for this
feature.

Vendor payment export formats for FinlandVendor payment export formats for Finland

    

Reason for deprecation/removalReason for deprecation/removal The payment formats are no longer used.

Replaced by another feature?Replaced by another feature? Yes, ISO20022 Credit transfer payment format for Finland

information and used in different local report printouts.

Telepay payment formats include vendor payment export (credit transfer) and customer payment collection

(direct debit).

Two formats for exporting payments are available for Finland. LM02 (FI) is used for domestic payments, and

LUM2 (FI) is used for foreign payments.



Product areas affectedProduct areas affected Accounts payable

StatusStatus Deprecated: A removal date has not been set for this
feature.

    

Warehouse management IIWarehouse management II

    

Reason for deprecation/removalReason for deprecation/removal The Warehouse management II solution (WMS II) that was
available in the Inventor y managementInventor y management  module
duplicates functionality that is in the WarehouseWarehouse
managementmanagement  module that was released in Dynamics AX
2012 R3.

Replaced by another feature?Replaced by another feature? The Warehouse managementWarehouse management  module that was released
in AX 2012 R3, Dynamics AX 2012 R3 CU8, and Dynamics
AX 2012 R3 CU9 replaces the Warehouse management II
features. The new module has more advanced features and
more flexible warehouse management processes than
Warehouse management II.

Product areas affectedProduct areas affected Inventory management, Sales and marketing, Procurement
and sourcing

StatusStatus Removed as of Dynamics 365 for Operations version 1611.

Worker reminders in Human ResourcesWorker reminders in Human Resources

    

Reason for deprecation/removalReason for deprecation/removal Low usage

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Human resources

StatusStatus Removed as of Dynamics 365 for Operations version 1611

Workflow for creating goalsWorkflow for creating goals

    

Reason for deprecation/removalReason for deprecation/removal Performance management has been completely redesigned
in Finance and Operations.

Human Resources Payroll information

A workflow for managing the creation of employee goals is one of several workflows that were available to help

coordinate the performance management process.



Replaced by another feature?Replaced by another feature? The redesigned Performance management feature gives
more control over the content of the goals, the
measurements that are used to track progress, and the
attachment of supporting documentation. Goals can be
stored as templates and then reused. This feature can help
you set up additional goals for your employees more quickly.

Product areas affectedProduct areas affected Human capital management

StatusStatus Removed as of Dynamics 365 for Operations version 1611.

    

Dynamics AX 7.0
Ability to cancel changes to a vendor invoiceAbility to cancel changes to a vendor invoice

    

Reason for deprecation/removalReason for deprecation/removal Performance enhancement

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Accounts payable

StatusStatus Removed as of Dynamics AX 7.0.

AIF, AxD, and AxBC integrationsAIF, AxD, and AxBC integrations

    

Reason for deprecation/removalReason for deprecation/removal The architecture of AIF and AxDs could not be scaled to a
cloud service. There were performance issues around bulk
import.

Replaced by another feature?Replaced by another feature? This feature is replaced by the Data Import/Export
framework, which supports recurring bulk import/export.
For AxBC, we recommend that you use the actual tables.

Product areas affectedProduct areas affected AxDs, AxBCs, and AIF

StatusStatus Removed as of Dynamics AX 7.0.

Billing code rate scriptsBilling code rate scripts

In Application Integration Framework (AIF), data can be exchanged with external systems through business logic

that is exposed as services. Dynamics AX includes services that are based on documents and .NET Business

Connector (AxBC). A document is created by using XML. The XML includes header information that is added to

create a message that can be transferred into or out of Dynamics AX. Examples of documents include sales

orders and purchase orders. However, almost any entity, such as a customer, can be represented by a document.

Services that are based on documents use the Axd <Document>Axd <Document> classes.

Billing scripts were used to calculate billing rates for billing codes. This scripts required custom development in

the C Sharp or Visual Basic programming language. In the current version of Dynamics AX, the billing codebilling code

rate scr iptsrate scr ipts  are not supported.



    

Reason for deprecation/removalReason for deprecation/removal The support for the custom C Sharp or Visual Basic scripts
was not added in Dynamics AX 7.0.

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Public sector, Accounts receivable

StatusStatus Removed as of Dynamics AX 7.0.

BOMs without BOM versionsBOMs without BOM versions

    

Reason for deprecation/removalReason for deprecation/removal Using a configuration key to control BOM versions doesn't
scale in a cloud environment.

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Product information management, Inventory management

StatusStatus Removed as of Dynamics AX 7.0.

Brazilian BorderoBrazilian Bordero

    

Reason for deprecation/removalReason for deprecation/removal Support for the Brazilian Bordero method of payment has
been discontinued from Brazilian localization

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Accounts payable

StatusStatus Deprecated: A removal date has not been set for this
feature.

Brazilian Sintegra statementBrazilian Sintegra statement

    

Reason for deprecation/removalReason for deprecation/removal This statement is no longer applicable in some Brazilian
states.

Replaced by another feature?Replaced by another feature? No. Users can use Generic Electronic reporting tool to
configure the statement if required under specific situations.

When the BOM versionsBOM versions  configuration key was disabled, bill of materials (BOM) versions were hidden in all

forms, and the system forced a 1:1 relationship between released products and BOMs. In the current version of

Dynamics AX, the BOM versionsBOM versions  configuration key can't be disabled.

Specific method of payment for Brazilian companies

Federal tax statement for ICMS tax



Product areas affectedProduct areas affected Fiscal books

StatusStatus Deprecated: A removal date has not been set for this
feature.

    

Brazilian SCAN contingency mode for NF-eBrazilian SCAN contingency mode for NF-e

    

Reason for deprecation/removalReason for deprecation/removal This method of contingency is no longer applicable in all
Brazilian states

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Accounts receivable

StatusStatus Deprecated: A removal date has not been set for this
feature.

Business AnalyzerBusiness Analyzer

    

Reason for deprecation/removalReason for deprecation/removal This functionality has been replaced by another feature.

Replaced by another feature?Replaced by another feature? The Monitor financial performance content pack for
Microsoft Power BI will include key financial metrics that
were previously available in Business Analyzer.

Product areas affectedProduct areas affected General ledger

StatusStatus Deprecated: The use of Business Analyzer has been
deprecated.

Business statisticsBusiness statistics

    

Reason for deprecation/removalReason for deprecation/removal Legacy approach to business intelligence (BI), low customer
usage, and a limited feature set

Replaced by another feature?Replaced by another feature? New BI solutions for the current version of Dynamics AX

Product areas affectedProduct areas affected Procurement and sourcing, Accounts payable, Sales and
marketing, Accounts receivable

StatusStatus Removed as of Dynamics AX 7.0.

(SCAN) contingency environment is used to generate, export, and import the status of a Nota Fiscal eletrônica

(NF-e) when the environment of Secretaria da Fazenda (SEFAZ) is not available.

This mobile application let users review key business metrics.

The setup of business statistics inquiries that can help you analyze the performance of the organization



Change document date function in Invoice approval journalChange document date function in Invoice approval journal

    

Reason for deprecation/removalReason for deprecation/removal Low usage

Replaced by another feature?Replaced by another feature? Yes. The document date on the posted vendor transaction
can be changed.

Product areas affectedProduct areas affected Accounts payable

StatusStatus Removed as of Dynamics AX 7.0.

ClieOp03 payment format for the NetherlandsClieOp03 payment format for the Netherlands

    

Reason for deprecation/removalReason for deprecation/removal The format is no longer applicable in the Netherlands,
because it has been replaced by SEPA functionality.

Replaced by another feature?Replaced by another feature? SEPA payments export

Product areas affectedProduct areas affected All modules

StatusStatus Deprecated: A removal date has not been set for this
feature.

Compliance CenterCompliance Center

    

Reason for deprecation/removalReason for deprecation/removal Lack of customer usage. Microsoft SharePoint includes the
same capability that was available in the Compliance Center.

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Compliance and internal controls

StatusStatus Removed as of Dynamics AX 7.0.

Connector for Microsoft DynamicsConnector for Microsoft Dynamics

    

Reason for deprecation/removalReason for deprecation/removal This functionality has been replaced by another feature.

Replaced by another feature?Replaced by another feature? Dataverse

Product areas affectedProduct areas affected Connector for Dynamics

The Compliance Center was an Enterprise Portal site for managing the documentation requirements for

compliance initiatives that are related to the Sarbanes-Oxley law.

This tool was used to integrate key data from Microsoft Dynamics CRM to Dynamics ERP applications.



StatusStatus Removed as of Dynamics AX 7.0.

    

Container unit and multi dimension on-handContainer unit and multi dimension on-hand

    

Reason for deprecation/removalReason for deprecation/removal Duplicate functionality

Replaced by another feature?Replaced by another feature? Yes. Since AX 2012, this functionality has been replaced by
the consolidated batch orders feature set. This feature set
includes the consolidated on-hand view.

Product areas affectedProduct areas affected Product information management, Production control,
Inventory management, Sales and marketing

StatusStatus Removed as of Dynamics AX 7.0.

Cue group metadataCue group metadata

    

Reason for deprecation/removalReason for deprecation/removal Cue groups were used to display one or more Cues in the
FactBox area. There was limited uptake, and there were also
performance concerns, because a record change in a parent
form caused one query per Cue in the Cue group.

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected All modules

StatusStatus Removed as of Dynamics AX 7.0.

Cue metadataCue metadata

    

Reason for deprecation/removalReason for deprecation/removal Cue metadata was limited to count or sum information.

Replaced by another feature?Replaced by another feature? Tile metadata was introduced to provide more flexibility for
modeling. For example, you can model current counts,
navigation, and key performance indicators (KPIs). Count tile
metadata is the direct replacement of the Cue metadata.

Product areas affectedProduct areas affected All modules

StatusStatus Removed as of Dynamics AX 7.0

Danish check formatDanish check format

    



Reason for deprecation/removalReason for deprecation/removal Support for the Danish check format layout has been
discontinued, and the report has been removed from DK
localization.

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected All modules

StatusStatus Deprecated: A removal date has not been set for this
feature.

    

Data partitionsData partitions

    

Reason for deprecation/removalReason for deprecation/removal Data partitions were introduced in Dynamics AX 2012 R2 to
enable data isolation. In a common scenario, a company has
subsidiaries, and the data from one subsidiary should not be
visible to another subsidiary, even though both subsidiaries
are managed by the same IT department. However, extra
scripts and management overhead throughout the program
were required in order to create new partitions and populate
them with data, and to back up partition data. In the cloud,
where we have access to platform as a service (PaaS)
database services (Microsoft Azure SQL Database), it's much
more efficient to use a database as the isolation container
than to do isolation in the program. Regardless of whether
data partitioning is required for subsidiaries, for multiple
tenants, or just for scale, we believe that the scenarios can
be handled better through multiple instances of Finance and
Operations.

Replaced by another feature?Replaced by another feature? Customers using data partitions must use multiple instances
of Finance and Operations if database level separation is a
critical issue.

Product areas affectedProduct areas affected All modules

StatusStatus Removed as of Dynamics AX 7.0.

Database and file share storage for attachmentsDatabase and file share storage for attachments

    

Data partitions provide a logical separation of data in the Dynamics AX database.

Dynamics AX 2012 allowed storage of attachments in the database and in file shares. Both of those options are

no longer supported.



Reason for deprecation/removalReason for deprecation/removal Files share storage is no longer supported because cloud-
hosted environments cannot communicate with local file
shares. Database storage has been deprecated in favor of
Azure Blob storage. Azure Blob storage is equivalent to
storage in the database, as documents can only be accessed
through Finance and Operations client forms. This provides
the added benefit of providing storage that doesn't
negatively affect the performance of the database. Blob
storage is the default storage mechanism for Document
Management and works immediately.

Replaced by another feature?Replaced by another feature? Database storage has been deprecated in favor of Azure
Blob storage.

Product areas affectedProduct areas affected All modules

StatusStatus Removed as of Dynamics AX 7.0.

    

DelimitationDelimitation

    

Reason for deprecation/removalReason for deprecation/removal No use of the functionality was found.

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Time and attendance

StatusStatus Removed as of Dynamics AX 7.0.

Desktop clientDesktop client

    

Reason for deprecation/removalReason for deprecation/removal The Dynamics AX client experience has been redesigned to
improve usability across multiple platforms and devices.

Replaced by another feature?Replaced by another feature? The new web client is based on the desktop Form metadata
and programming model that have been modified to
provide a rich web platform.

Product areas affectedProduct areas affected All modules

StatusStatus Removed as of Dynamics AX 7.0.

Direct database connectionDirect database connection

    

In Dynamics AX 2012 R3, Retail Modern POS could connect directly to the Channel DB in similar fashion to

Enterprise POS. This was in addition to the standard communication method of Retail Modern POS

communicating through Retail Server.



Reason for deprecation/removalReason for deprecation/removal Direct database connectivity required lower security
protocols and was primarily used to achieve the highest
levels of performance. Due to the performance and security
enhancements that have occurred in Finance and
Operations, this functionality now causes more issues than it
solves.

Replaced by another feature?Replaced by another feature? No. Only standard Retail Server communication is now
supported.

Product areas affectedProduct areas affected Channel DB/Retail Modern POS

StatusStatus Removed as of Dynamics AX 7.0.

    

Dutch SWIFT MT940Dutch SWIFT MT940

    

Reason for deprecation/removalReason for deprecation/removal Generic functionality is now used instead of localized
functionality.

Replaced by another feature?Replaced by another feature? Yes, this functionality has been replaced by Advanced bank
reconciliation functionality.

Product areas affectedProduct areas affected All modules

StatusStatus Deprecated: A removal date has not been set for this
feature.

eBilanz (XBRL for Germany)eBilanz (XBRL for Germany)

    

Reason for deprecation/removalReason for deprecation/removal Lack of customer usage

Replaced by another feature?Replaced by another feature? This feature hasn't been replaced by another feature, but
multiple specialized XBRL packages that provide rich XBRL
functionality are available for the German market.

Product areas affectedProduct areas affected Management Reporter

StatusStatus Deprecated: A removal date has not been set for this
feature.

Enterprise Portal clientEnterprise Portal client

    

Reason for deprecation/removalReason for deprecation/removal A single client platform has been provided.

This functionality provided eXtensible Business Reporting Language (XBRL) output that is intended specifically

for the German eBilanz taxonomy.



Replaced by another feature?Replaced by another feature? The new web client is based on the desktop form metadata
and programming model that have been modified to
provide a rich web platform.

Product areas affectedProduct areas affected All modules

StatusStatus Removed as of Dynamics AX 7.0.

    

Environmental sustainabilityEnvironmental sustainability

    

Reason for deprecation/removalReason for deprecation/removal Low customer usage and a limited feature set

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Compliance and internal controls, Accounts payable

StatusStatus Removed as of Dynamics AX 7.0.

Form ActiveX and Managed Host controlsForm ActiveX and Managed Host controls

    

Reason for deprecation/removalReason for deprecation/removal The ActiveX and Managed Host controls are based on the
deprecated desktop client.

Replaced by another feature?Replaced by another feature? The extensible control framework supports building new
controls that are based on HTML, CSS, and JavaScript, and is
a first-class control in the Microsoft Visual Studio Tooling
environment.

Product areas affectedProduct areas affected All modules

StatusStatus Removed as of Dynamics AX 7.0.

Generate prenotes by using a batchGenerate prenotes by using a batch

    

Reason for deprecation/removalReason for deprecation/removal No form exists to persist and display the resulting prenote
file when it's generated by using a batch.

Replaced by another feature?Replaced by another feature? Prenotes can still be generated, and the user has control
over the location where the file is saved.

Product areas affectedProduct areas affected Accounts payable, Accounts receivable, Cash and bank
management

StatusStatus Removed as of AX 7.0.

German DTAUS payment export and account statement import (totals and transactions)German DTAUS payment export and account statement import (totals and transactions)

Prenote generation can't be done by using a batch, but it can still be done by a user.



    

Reason for deprecation/removalReason for deprecation/removal The format is no longer applicable in Germany, because it
has been replaced by Single Euro Payments Area (SEPA)
functionality.

Replaced by another feature?Replaced by another feature? Yes, this functionality has been replaced by SEPA payment
export and advanced bank reconciliation functionality for
importing account statements.

Product areas affectedProduct areas affected All modules

StatusStatus Deprecated: A removal date has not been set for this
feature.

German DTAZV payment format in domestic CurrencyGerman DTAZV payment format in domestic Currency

    

Reason for deprecation/removalReason for deprecation/removal The format is no longer applicable in Germany, because it
has been replaced by SEPA functionality.

Replaced by another feature?Replaced by another feature? SEPA payments export

Product areas affectedProduct areas affected Accounts payable

StatusStatus Deprecated: A removal date has not been set for this
feature.

German MT940 importGerman MT940 import

    

Reason for deprecation/removalReason for deprecation/removal Generic functionality is now used instead of localized
functionality.

Replaced by another feature?Replaced by another feature? Yes, this functionality has been replaced by Advanced bank
reconciliation functionality.

Product areas affectedProduct areas affected All modules

StatusStatus Deprecated: A removal date has not been set for this
feature.

German XML EU Sales listGerman XML EU Sales list

    

Reason for deprecation/removalReason for deprecation/removal The XML format for German EU Sales List reporting is no
longer supported. Only the ELMA5 text file format can be
used to submit the EU Sales List report to the German Tax
Office.

Replaced by another feature?Replaced by another feature? No



Product areas affectedProduct areas affected Tax

StatusStatus Deprecated: A removal date has not been set for this
feature.

    

GL SSRS reportsGL SSRS reports

    

Reason for deprecation/removalReason for deprecation/removal Financial Microsoft SQL Server Reporting Services (SSRS)
reports have been replaced by Management Reporter
capabilities and default reports.

Replaced by another feature?Replaced by another feature? Management Reporter (labeled Financial repor tingFinancial repor ting in the
current version of Dynamics AX)

Product areas affectedProduct areas affected General ledger

StatusStatus Removed as of Dynamics AX 7.0.

InfoPart and FormPart metadataInfoPart and FormPart metadata

    

Reason for deprecation/removalReason for deprecation/removal InfoPart and FormPart metadata enabled the creation of
FactBoxes for two different clients.

Replaced by another feature?Replaced by another feature? InfoPart metadata, which was a simplified form definition, is
converted into a Form by upgrade tooling. FormPart
metadata, which referenced a Form, is replaced by a more
direct reference that is created by upgrade tooling.

Product areas affectedProduct areas affected All modules

StatusStatus Removed as of Dynamics AX 7.0.

Main account list pageMain account list page

    

Reason for deprecation/removalReason for deprecation/removal Balance information is available on the Trial balanceTrial balance list
page by account and dimension.

Replaced by another feature?Replaced by another feature? Main accountsMain accounts contains the same list of accounts that the
Main accountMain account  list page contained. The grid view in MainMain
accountsaccounts also shows an even smaller, grid-like view.

Product areas affectedProduct areas affected General ledger

Reports that include the following menu items have been removed: Summar y tr ial balanceSummar y tr ial balance, Detailed tr ialDetailed tr ial

balancebalance, Char t of accountsChar t of accounts , Audit trailAudit trail , BalancesBalances , and Balance listBalance list.

A list of accounts for the legal entity and related balance information



StatusStatus Removed as of Dynamics AX 7.0.

    

Malaysia and Singapore bank cash flow reportMalaysia and Singapore bank cash flow report

    

Reason for deprecation/removalReason for deprecation/removal The same information can be obtained from the Inquiry
bank transaction.

Replaced by another feature?Replaced by another feature? The Inquiry bank transaction

Product areas affectedProduct areas affected Cash and bank management

StatusStatus Deprecated: A removal date has not been set for this
feature.

Mexican CFD electronic invoiceMexican CFD electronic invoice

    

Reason for deprecation/removalReason for deprecation/removal The method is no longer applicable. The generation of
electronic invoices by using the CFD method was deprecated
by the tax authorities and replaced by the Comprobante
Fiscal Digital a través de Internet (CFDI) method, where the
signing is delegated to the third-party provider (PAC). The
monthly report has been removed, and an inquiry option
lets users inquire about historical transactions.

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Account receivables, Project

StatusStatus Deprecated: A removal date has not been set for this
feature.

Mexico realized and unrealized VATMexico realized and unrealized VAT

    

Reason for deprecation/removalReason for deprecation/removal Duplicate functionality

Replaced by another feature?Replaced by another feature? Yes, this functionality has been replaced by standard
conditional sales tax functionality that is provided by Core.

This feature let the user print a cash flow report that shows transactions and details of the cash inflows and

outflows for a specific date range for selected bank accounts.

This feature enabled the generation of Mexican electronic invoices by using the Comprobante Fiscal Digital

(CFD) method, where the company signs the invoice by requesting the related authorization from the

government. This feature also provides a monthly report that includes all electronics invoices that were issued in

the period.

Dynamics AX 2012 managed unrealized value-added tax (VAT) by using Mexico-specific functionality for

unrealized tax.



Product areas affectedProduct areas affected Tax

StatusStatus Deprecated: A removal date has not been set for this
feature.

    

Microsoft Outlook integrationMicrosoft Outlook integration

    

Reason for deprecation/removalReason for deprecation/removal This functionality has been replaced by Microsoft Exchange
Server integration.

Replaced by another feature?Replaced by another feature? Yes

Product areas affectedProduct areas affected Sales and marketing

StatusStatus Removed as of Dynamics AX 7.0.

Private blocking of inventory and warehouse management journalsPrivate blocking of inventory and warehouse management journals

    

Reason for deprecation/removalReason for deprecation/removal No use of the functionality was found.

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Inventory management

StatusStatus Removed as of Dynamics AX 7.0.

Product builderProduct builder

    

Reason for deprecation/removalReason for deprecation/removal Product builder exposed X++ code to end users and isn't
supported in the current version of Dynamics AX. It has
been removed to avoid duplicate maintenance efforts on
overlapping, sizeable codebases.

Replaced by another feature?Replaced by another feature? Yes. The constraint-based configuration was introduced in
Dynamics AX 2012 where the depreciation of Product
builder in future versions was already announced. The
constraint-based configuration technology is selected on the
product masters to enable the configuration. To learn more,
see Product configuration overview.

The inventory and warehouse journals no longer support the ability to mark a journal as private for a selected

user. Only the process of blocking journals as private for user groups and blocking during editing is supported.

Product builder was used to dynamically configure items from a sales order, purchase order, production order,

sales quotation, project quotation, or item requirement. Based on a product model that had modeling variables,

the user could select values to meet the customer requirements and get a unique product variant that had a

BOM and route.



Product areas affectedProduct areas affected Product information management, Sales and marketing

StatusStatus Removed as of Dynamics AX 7.0.

    

Production Floor appProduction Floor app

    

Reason for deprecation/removalReason for deprecation/removal With the change to a web-based client, it is possible to
deliver similar functionality through the native Dynamics AX
7.0 client. The Job Card Device provides a production floor
user interface that is optimized for touch and tablet form
factors.

Replaced by another feature?Replaced by another feature? Yes. The Job Card Device, which is a native part of Dynamics
AX 7.0.

Product areas affectedProduct areas affected Production control

StatusStatus Deprecated: A removal date from the Microsoft store has
not yet been set for this feature.

Rename product dimensionRename product dimension

    

Reason for deprecation/removalReason for deprecation/removal The current version of Dynamics AX doesn't support label
changes at run time.

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected Product information management

StatusStatus Removed as of Dynamics AX 7.0.

Retail Server connectivity using HTTPRetail Server connectivity using HTTP

    

Reason for deprecation/removalReason for deprecation/removal Due to new security requirements, only secured
communication using TLS 1.2 (or above, as available) is now
supported. The self-service installer will automatically
configure the computer for this communication.

Replaced by another feature?Replaced by another feature? No. Only standard HTTPS communication is now supported.

This is the app for tablet devices running Windows 8.1 RT and Windows 8.1 Pro.

This feature let you change the name of one of the three standard product dimensions (size, color, or style) to a

name that better suited your business requirements. Renaming included all the labels where the product

dimension name was used.

In Dynamics AX 2012 R3, the Retail Server could function using HTTP communication (non-secured). This was in

addition to the standard communication using HTTPS.



Product areas affectedProduct areas affected Retail Server

StatusStatus Removed as of Dynamics AX 7.0.

    

Role Center pagesRole Center pages

    

Reason for deprecation/removalReason for deprecation/removal Role Center pages were built on the deprecated Enterprise
Portal platform, which has been replaced by the new web
client platform in the current version of Dynamics AX.

Replaced by another feature?Replaced by another feature? The new Workspace form pattern provides users with a
process-centered design that provides easy access to
commonly used tasks within that process.

Product areas affectedProduct areas affected All modules

StatusStatus Removed as of Dynamics AX 7.0

Sales tax jurisdictionsSales tax jurisdictions

    

Reason for deprecation/removalReason for deprecation/removal Low customer usage and a limited feature set

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected US sales tax

StatusStatus Removed as of Dynamics AX 7.0.

Sites ServicesSites Services

    

Reason for deprecation/removalReason for deprecation/removal The Microsoft Azure infrastructure that is used by Dynamics
AX has new capabilities that can be used instead (for
example, Azure sites).

Replaced by another feature?Replaced by another feature? No

Product areas affectedProduct areas affected HR recruiting, Case management, Request for quotes,
Vendor registration, Collaborative workspaces for
opportunities and campaigns

StatusStatus Removed as of Dynamics AX 7.0.

SSAS demand forecasting strategySSAS demand forecasting strategy

Sites Services let you build websites that extend your business processes to the Internet without IT support.



    

Reason for deprecation/removalReason for deprecation/removal The design of the feature cannot be supported in the new
cloud architecture.

Replaced by another feature?Replaced by another feature? Azure Machine Learning demand forecasting strategy

Product areas affectedProduct areas affected Master planning

StatusStatus Removed as of Dynamics AX 7.0.

Vendor invoice pool excluding posting detailsVendor invoice pool excluding posting details

    

Reason for deprecation/removalReason for deprecation/removal Low usage. This functionality has been replaced by the
Invoice journal that has workflow functionality.

Replaced by another feature?Replaced by another feature? Workflow capabilities of the Invoice journal.

Product areas affectedProduct areas affected Accounts payable

StatusStatus Removed as of Dynamics AX 7.0.

Virtual company accountsVirtual company accounts

    

Reason for deprecation/removalReason for deprecation/removal - Virtual companies must be set up before data is stored in
the tables. Retrofitting virtual companies onto an existing
implementation is very difficult.

- Because there has been so much data normalization in the
current version of Dynamics AX, it has become difficult to
know what to add to the table collections. For example, it's
difficult to know which tables to share. All the tables
referenced from tables that are in a virtual company must
also added. Because of table normalization, even simple
master data that is spread across multiple tables must be
part of the virtual company. Any mistake that is made here
will cause functional issues.

- When a table is part of a virtual company, it loses
information about the origin of the data, and only the virtual
company is recorded.

Replaced by another feature?Replaced by another feature? Global tables can be used to make tables accessible from all
companies. Currently, there is no replacement.

Product areas affectedProduct areas affected All modules

The virtual companies feature is no longer supported in Dynamics AX. The virtual companies feature let users

set up tables that could be shared by a set of companies. For a description of the feature, see Company accounts

and Virtual company accounts. The feature works by grouping tables into collections that are assigned to virtual

companies, which are groups of existing “real” companies. Queries are created so that all the companies in the

virtual company can access the data in the tables of the associated table collections.

https://msdn.microsoft.com/library/aa834382(v=ax.10).aspx


StatusStatus Removed as of Dynamics AX 7.0.

    

Windows 8 tablet appWindows 8 tablet app

    

Reason for deprecation/removalReason for deprecation/removal Finance and Operations is compatible with tablets. The tablet
app is no longer required.

Replaced by another feature?Replaced by another feature? No.

Product areas affectedProduct areas affected Expense management

StatusStatus Removed: This functionality is only available for Dynamics AX
2012 R3.

WorkplannerWorkplanner

    

Reason for deprecation/removalReason for deprecation/removal Low usage

Replaced by another feature?Replaced by another feature? No, but the Profile relationProfile relation page, which is opened from
the Profile groupsProfile groups page, supports the same business
scenario as the deprecated WorkplannerWorkplanner  page.

Product areas affectedProduct areas affected Time and attendance

StatusStatus The code has not been removed. However, the form,
JmgWorkPlanner, was not migrated.

X++ financial statementsX++ financial statements

    

Reason for deprecation/removalReason for deprecation/removal This functionality has been replaced by another feature.

Replaced by another feature?Replaced by another feature? Management Reporter (labeled Financial repor tingFinancial repor ting in the
current version of Dynamics AX)

Product areas affectedProduct areas affected General ledger

StatusStatus Removed as of Dynamics AX 2012

NOTENOTE

The Windows 8 tablet app provided functionality for expense entry and approval.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Absence management in Human
resources

Functionality for entering absence
transactions isn't included. Additionally,
functionality for approving absence
transactions as a manager isn't
included. Setup capabilities that are
required for integration with other
modules are available through the
Human Resources 2Human Resources 2  configuration
key.

Implemented in Dynamics 365 Human
Resources

Alerts Alerts help users keep track of data
changes in the system.

Implemented in Platform update 15

Bank payment order for Latvia and
Lithuania

You can print a payment order for
Latvia and Lithuania. This feature will
be available in a future update.

Not implemented

Bankgirot AP return format for
Sweden

The Bankgirot return format is used to
import bank return messages. This
feature will be available in a future
update.

Not implemented

Client drag-and-drop The web client controls have
application programming interfaces
(APIs) for drag-and-drop operations,
but these APIs are based on the
deprecated desktop client technology
and they require a redesign so that
they work on the new web client
platform. APIs that support drag-and-
drop operations will be reviewed for
inclusion in a future update.

Not implemented

Client right-to-left (RTL) layout RTL layout is now supported. Implemented in Platform update 2

This topic lists features of Microsoft Dynamics AX 2012 that were postponed. These features weren't

implemented in Microsoft Dynamics AX 7.0. In the following table, the Current statusCurrent status  column indicates

whether the feature has been implemented since the AX 7.0 release.

For a detailed list of the release date for each version, see Software lifecycle policy and cloud releases.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/ax-2012-features-not-implemented-but-not-deprecated.md


Cost accounting The Cost accountingCost accounting module is
designed to meet the requirements of
internal costs and profitability reports
at multiple organizational levels. To
define the cost object level, the module
depends on a correct mapping of
financial dimensions. The module lets
you perform advanced allocations of
cost origin from expenditures that are
registered in the general ledger or
budget. It also lets you compare
realized costs and budgeted costs.

Implemented in version 1611

Customer self-service (CSS) CSS lets you create approved customer
records. It also allows users to view
selected product catalogs, order items,
and view the status of invoices.
Additionally, CSS lets you create and
follow return orders.

Not implemented

Customizable help topics The ability to create customized help
topics has not yet been implemented.
Custom task guides and custom field
help are available. This feature will be
available in a future update.

Not implemented

Employee self-service (ESS) ESS shows employees several tiles that
have task-related and career-related
information on a single page.
Employees can view pending work
items and click links that open pages
where they can take action on their
tasks. ESS pages also show employees
the status of their certifications, when
their next performance reviews are
scheduled, skills, goals, and
compensation information, and other
information, such as balances for
vacation and sick time. Employees can
also access a company directory from
their ESS page.

Implemented in version 1611

External questionnaire and recruiting
functionality

Functionality for externally posting
questionnaires and open jobs will be
added to Human Resources in a future
update.

External questionnaire functionality
hasn't been implemented.

Fiscal printers for Poland Integration with Polish fiscal printers
enables the required information to be
sent to the fiscal printer in the correct
format during invoice posting.
Examples of Polish fiscal printers
include the Posnet Thermal and Elzab
Omega printer types. This feature will
be available in a future update.

Not implemented

A X 2012 F EAT URE T H AT  WA SA X 2012 F EAT URE T H AT  WA S
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Recruiting functionality is available
in Microsoft Dynamics 365 Talent:
Attract.



General budget reservations The General budget reservations
document is sometimes referred to as
a commitment. Public sector entities
often use this document to set aside
or earmark budgeted funds so that
they aren't available for other
purposes.

Implemented in version 8.1

GraphicsGraphics  tab on the Fixed assetFixed asset
value modelvalue model and DepreciationDepreciation
book profilebook profile pages

The chart shows the depreciation,
accumulated depreciation, and net
book value over time. Users can click
the DataData tab to view more detailed
information than the chart shows. This
chart will be redesigned in a future
update.

Not implemented

Intelligent Data Management
Framework (IDMF)

IDMF is an add-on tool that lets
system administrators optimize
performance. IDMF assesses the health
of the application, analyzes current
usage patterns, and helps reduce
database size.

Not implemented

Microsoft Project client integration The Microsoft Project client is
integrated with projects.

Implemented in version 7.2 (July 2017
update)

Procurement site In previous versions, the Employee
self-service procurement site lets you
enter requisitions for employees, view
the status of an order (created,
received, or receipt confirmed), and
request onboarding of a new vendor.
You could configure different
procurement catalogs to show on the
site depending on policy. You could
also design procurement catalogs by
adding new nodes. In the current
version, procurement catalog
capabilities are reduced and are used
only to limit the products that can be
ordered for an organization. The
structure is always based on the
Procurement categories hierarchy.
Additionally, on the procurement site
the employee could approve a vendor
invoice and confirm receipts in relation
to the requisitions and derived
purchase orders.

Not implemented

Secure global address book The ability to help secure the global
address book by legal entity and
address book is not available. This
feature will be available in a future
update.

Not implemented

Specifications for Electronic reporting
(ER) payment formats

Currently, you must enter the payment
format specifications manually. In a
future update, you will be able to
select payment format specifications in

Not implemented
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a list. The following payment
specifications are currently supported
per payment format.

[!NOTE] Values for these
supported payment specifications
are used as payment specification
parameters on the PaymentPayment
specificationspecification page for a selected
method of payment.

PAY M E N TPAY M E N T

S P E C I F I C AT I O NS P E C I F I C AT I O N

( U S E D  I N  E R )( U S E D  I N  E R )

E X P O R T  F O R M ATE X P O R T  F O R M AT

D E S C R I P T I O ND E S C R I P T I O N

ChqBen Cheque,
Begunstigde

ChqOff Cheque,
Kantoor
opdrachtgever

ChqPri Cheque,
Opdrachtgever

TrfBenBen Overboeking
Begunstigde/Be
gunstigde

TrfBenBenUrg Overboeking
Begunstigde/Be
gunstigde
Spoed

TrfEurBen Overboeking
Euro/Begunstig
de

TrfEurBenUrg Overboeking
Euro/Begunstig
de Spoed

TrfEurEur Overboeking
Euro/Euro

TrfEurEurUrg Overboeking
Euro/Euro
Spoed

TrfForBen Overboeking
VV-
rekening/Begun
stigde

TrfForBenUrg Overboeking
VV-
rekening/Begun
stigde Spoed

TrfForFor Overboeking
VV-
rekening/VV-
rekening
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BTL91 for the NetherlandsBTL91 for the Netherlands



TrfForForUrg Overboeking
VV-
rekening/VV-
rekening Spoed

PAY M E N TPAY M E N T

S P E C I F I C AT I O NS P E C I F I C AT I O N

( U S E D  I N  E R )( U S E D  I N  E R )

E X P O R T  F O R M ATE X P O R T  F O R M AT

D E S C R I P T I O ND E S C R I P T I O N

PAY M E N TPAY M E N T

S P E C I F I C AT I O NS P E C I F I C AT I O N

( U S E D  I N  E R )( U S E D  I N  E R )

E X P O R T  F O R M ATE X P O R T  F O R M AT

D E S C R I P T I O ND E S C R I P T I O N

B0112 BS-B 0112: Lang
tekst & adresse

B0113 BS-B 0113:
Erstat. bet. lang
tekst

T0112 BS-T 0112: Lang
tekst & adresse

T0117 BS-T
0117:FIK;kort
frist;lang
tekst&adr.

PAY M E N TPAY M E N T

S P E C I F I C AT I O NS P E C I F I C AT I O N

( U S E D  I N  E R )( U S E D  I N  E R )

E X P O R T  F O R M ATE X P O R T  F O R M AT

D E S C R I P T I O ND E S C R I P T I O N

56 Currency
account transfer
between
Nordea
accounts in
Denmark

47 Domestic check

45 Domestic
transfer

50 Express transfer

55 Intercompany
transfer
(domestic)

51 Intercompany
transfer to a
foreign bank

54 International
check

52 Nordea
intercompany
payment
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Betalingsser vice for DenmarkBetalingsser vice for Denmark

Nordea vendor for DenmarkNordea vendor for Denmark



43 Request for
transfer

46 Transfer
form/giro
payment

PAY M E N TPAY M E N T

S P E C I F I C AT I O NS P E C I F I C AT I O N

( U S E D  I N  E R )( U S E D  I N  E R )

E X P O R T  F O R M ATE X P O R T  F O R M AT

D E S C R I P T I O ND E S C R I P T I O N

PAY M E N TPAY M E N T

S P E C I F I C AT I O NS P E C I F I C AT I O N

( U S E D  I N  E R )( U S E D  I N  E R )

E X P O R T  F O R M ATE X P O R T  F O R M AT

D E S C R I P T I O ND E S C R I P T I O N

Tp1.ESROPS Type 1 - ESR
orange payment
slip

Tp21.ISR1SPS Type 2.1 - IS red
1 stage
payment slip

Tp22.ISR2SPS Type 2.2 - IS red
2 stage
payment slip

Tp7.Dmstc Type 7 -
Domestic postal
order

TpE1.PSWR Type E1 -
Payment slip
with reference

TpE2.PSWN Type E2 -
Payment slip
with
notifications

PAY M E N TPAY M E N T

S P E C I F I C AT I O NS P E C I F I C AT I O N

( U S E D  I N  E R )( U S E D  I N  E R )

E X P O R T  F O R M ATE X P O R T  F O R M AT

D E S C R I P T I O ND E S C R I P T I O N

Varsling AvtaleGiro-trans
with notification

PAY M E N TPAY M E N T

S P E C I F I C AT I O NS P E C I F I C AT I O N

( U S E D  I N  E R )( U S E D  I N  E R )

E X P O R T  F O R M ATE X P O R T  F O R M AT

D E S C R I P T I O ND E S C R I P T I O N

Melding Autogiro-trans
with notification
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ISO20022 Credit transfer (CH)ISO20022 Credit transfer (CH)

AvtaleGiro (NO)AvtaleGiro (NO)

AutoGiro (NO)AutoGiro (NO)

eFaktura (NO)eFaktura (NO)



PAY M E N TPAY M E N T

S P E C I F I C AT I O NS P E C I F I C AT I O N

( U S E D  I N  E R )( U S E D  I N  E R )

E X P O R T  F O R M ATE X P O R T  F O R M AT

D E S C R I P T I O ND E S C R I P T I O N

Reklame Include
advertising flag

PAY M E N TPAY M E N T

S P E C I F I C AT I O NS P E C I F I C AT I O N

( U S E D  I N  E R )( U S E D  I N  E R )

E X P O R T  F O R M ATE X P O R T  F O R M AT

D E S C R I P T I O ND E S C R I P T I O N

EasyAccountTra
nsfer

Easy-account
with CVR (NKV)

Paym_slip Transfer forms
(OCR)

PAY M E N TPAY M E N T

S P E C I F I C AT I O NS P E C I F I C AT I O N

( U S E D  I N  E R )( U S E D  I N  E R )

E X P O R T  F O R M ATE X P O R T  F O R M AT

D E S C R I P T I O ND E S C R I P T I O N

A OP (payment
order), DOC
(wire transfer),
TED (other type
of wire transfer),
and direct credit
in the account

J Bar code
payments
(invoice with bar
code or other
type of
documents with
bar code)

O Tax payments or
other publics
services
payments

US Payroll US Payroll provides gross-to-net
processing for employees in the United
States. In Payroll, you can set up, enter,
and maintain all payroll records and
transactions.

Implemented in version 1611

A X 2012 F EAT URE T H AT  WA SA X 2012 F EAT URE T H AT  WA S
P O ST P O N EDP O ST P O N ED DESC RIP T IO NDESC RIP T IO N

C URREN T  STAT US ( A S O F  F EB RUA RYC URREN T  STAT US ( A S O F  F EB RUA RY
2019)2019)

ISO20022 Credit transfer (DK)ISO20022 Credit transfer (DK)

ISPAG-CNAB240 format (BR)ISPAG-CNAB240 format (BR)



Vendor collaboration (Vendor Portal) Dynamics AX 2012 provided vendor
portal capabilities via Enterprise Portal.
Financial and Operations also provides
these capabilities. In version 7.1 (also
known as Dynamics 365 for
Operations 1611), a vendor could view
and respond to purchase orders.

Implemented in version 7.3

Vendor requests - external request to
become a new vendor

Dynamics AX 2012 provided the ability
for an anonymous user to sign up to
be a vendor in the system, which could
lead to a vendor request for adding a
new vendor to the vendor master. In
version 7.3, the anonymous request
from a prospective vendor can be
imported via an entity (Data
Management/OData), which can lead
to inviting the vendor - or the vendor's
contact person - to register more
details about the prospective vendor.
The information provided is included in
a new vendor request that can be
reviewed and approved via a workflow
process. An approval of the vendor
request leads to creation of a new
vendor account.

Implemented in version 7.3

Vendor requests in general Dynamics AX 2012 had a concept of
vendor requests that served various
purposes related to updating vendor-
related information, such as requesting
new procurement categories for the
vendor, internal employees requesting
new vendors, or requesting to add a
vendor to another company. Only the
vendor's request of being added as a
vendor has been implemented in
version 7.3.

Not implemented
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In version 7.3, the vendor can view
and respond to RFQs. Vendors can
also view and edit selected
information from the vendor
record such as addresses, contact
information, and contact persons,
and they can upload documents in
relation to their certifications.



[Russia] Tax registers Legal entities can use registers to
disclose their revenues and expenses.
The registers are used to track revenue
and expense data from the time that
primary documents, such as sales
invoices and delivery notes, are first
entered by using the calculation of
cost prices for production. The data
from the registers is used to confirm
the declared profit of the legal entity.
This functionality includes the following
features:

Implemented in version 8.1.3

[Russia] Electronic export/import
format for Client-Bank interface and
reconciliation procedure

Electronic formats for export of
outgoing payments, and import of
incoming payments.

Implemented in version 8.1.3

[Russia] VAT declaration Electronic format of VAT declaration. Implemented in version 10.0.1

[Russia] Cash Flow Management The functionality which obtains a cash
flow forecast and performs an analysis,
manages payments on a daily basis
using payment schedule journals,
controls the company's cash position,
and maintains the company's cash
flows with centralized control,

Implemented in version 10.0.1
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Current period incomes

Tax expenses

Other expenses of current
period

Unrealized expenses of current
period

Other unrealized expenses

Accounts receivable debt –
inventory

Bad debts reserve calculation

Bad debts reserve movement

Accounts receivable movement

Procedure for writing-off AR
bad debts

Accounts payable debt -
inventory

Accounts payable debt
movement

Procedure for writing-off AP
bad debts

Goods cost calculation

FA object information

IA object information

FA depreciation

IA depreciation

FA/IA sale

Depreciation bonus recovery



[Russia] Accounting reporting format Electronic format of the following
accounting reports: BalanceSheet,
IncomeStatement, CashFlow,
EquityStatement, TargetUsageMoney

Implemented in version 10.0.1

[Russia] Assessed tax reporting Assessed tax declaration. Implemented in version 10.0.1

[Russia] Land tax reporting Land tax declaration. Creation of Land
tax declaration by separate divisions.

Implemented in version 10.0.1

[Russia] Transport tax reporting Transport tax declaration. Implemented in version 10.0.1

[Russia] Indirect tax return (VAT and
Excise) on import of goods

Indirect (withholding) tax return (VAT
and Excise) on import of goods from
state members of Customs union.

Implemented in version 10.0.1

[Russia] Journal of Alcohol sales in
Retail

Daily Alcohol journal. Implemented in version 10.0.1

[Russia] Optional posting of transfer
orders to General ledger

Option to post/not post transactions
to General ledger when posting a
transfer order.

Implemented in version 8.1.2

[Russia] Inventory owner Inventory dimension used to track
owner of inventory (consignment
stock, bailment, tolling, etc.).

Implemented in version 10.0.1

[Russia] AP/AR - Third-party
miscellaneous charges

Registration of third-party
miscellaneous charges and allocation
by the following regimes: Inclusion into
cost of purchased goods (allocation to
invoices lines from other vendors), and
redrawing to other parties re-
allocation to other expense accounts.

Implemented in version 8.1.1

[Russia] Goods in transit from vendor Registering goods in transit from
vendor by special posting profile with
Item type "purchased items en route".
Creating Act of inventory holdings en
route. (INV-6)

Implemented in version 8.1.2

[Russia] Goods in transit - sales to
customer with postponed passing of
property

Post sales invoice with postponed
property transfer: no customer debts
posted, all outgoing taxes are posted,
items are transferred to transit
warehouse. Register passing of
property with posting debts and items
sale from transit warehouse.

Implemented in version 8.1.2

[Russia] Bailment - accounting at
bailee side

Accounting of inventory receipt for
bailment as required by the Law and
generation of primary form MX-1.
Accounting of inventory return from
bailment and generation of primary
form MX-3. Bailment costs calculation
from bailee side.

Implemented in version 8.1.2
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[Russia] Bailment - accounting at
owner side

Accounting of inventory transfer to
bailment and inventory return from
bailment on goods owner side under
bailment service contract.

Implemented in version 8.1.2

[Russia] Localization of Process
Industries solution

Basic localization in two areas:
correspondence of accounts for all new
general ledger postings, and functional
coexistence of Process Industries
features and Russian country context
(no issues when both Process
Industries and Russian country context
are enabled).

Implemented in version 10.0.1

[Russia] Alcohol sales declarations:
Application 6, 7, 8 for wholesale.
Applications 11, 12 for retail

Keeping track of alcoholic beverages
types including producers, unit of
measures, licenses for retail and
wholesale trade. Preparing data for
alcoholic beverages activities, including
printing declarations and exporting
them in XML format through e-
reporting.

Implemented in version 10.0.1
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End of mainstream support for Microsoft Dynamics
AX 2009, Dynamics AX 2012, and Dynamics AX 2012
R2
2/18/2021 • 4 minutes to read • Edit Online

Frequently asked questions
When does the mainstream support for Dynamics AX 2009 Service Pack 1, Dynamics AX 2012, and DynamicsWhen does the mainstream support for Dynamics AX 2009 Service Pack 1, Dynamics AX 2012, and Dynamics
AX 2012 R2 end?AX 2012 R2 end?

Was the information of the end date of the mainstream support for Dynamics AX 2009 Service Pack 1,Was the information of the end date of the mainstream support for Dynamics AX 2009 Service Pack 1,
Dynamics AX 2012, and Dynamics AX 2012 R2 available before?Dynamics AX 2012, and Dynamics AX 2012 R2 available before?

Can customers on Premier Extended Hotfix Support or on Unified Support Advanced and PerformanceCan customers on Premier Extended Hotfix Support or on Unified Support Advanced and Performance
Levels get a non-security hotfix or regulatory update?Levels get a non-security hotfix or regulatory update?

Mainstream support for Dynamics AX 2009 Service Pack 1 (SP1), Dynamics AX 2012, and Dynamics AX 2012 R2

ends on October 9, 2018. After that date, only security hotfixes will continue to be provided for these three

versions through the extended support period that continues until October 12, 2021. For more information, see

support.microsoft.com.

Mainstream support for Dynamics AX 2012 R3 continues through October 12, 2021. Microsoft will continue

making security hotfixes, non-security hotfixes, and regulatory updates for Dynamics AX 2012 R3 throughout

that mainstream support period. The source code for these non-binary, non-security hotfixes and regulatory

updates will continue to be available for customers, and their partners, active on the Enhancement Plan or

Software Assurance.

Dynamics AX 2009 SP1, Dynamics AX 2012, and Dynamics AX 2012 R2 customers can selectively integrate

those changes as required. Customers and partners can get the source code from packages attached to relevant

Dynamics AX 2012 R3 KB articles published on Lifecycle Services (LCS) and discoverable through Issue Search.

Customers are advised to upgrade to the latest version of Finance and Operations apps, such as Dynamics 365

Finance, Supply Chain Management, Retail, and Human Resources:

Dynamics AX 2009 Service Pack 1 customers should use the migration tool that is available.

Dynamics AX 2012 and Dynamics AX 2012 R2 customers should upgrade to Finance and Operations apps

through Dynamics AX 2012 R3 using the upgrade tool that is available. Additional upgrade information is

available in the Upgrade from AX 2012 to Finance and Operations apps topic.

Mainstream support ends on October 9, 2018.

Yes, it was always publicly available on the Microsoft Support Lifecycle site at support.microsoft.com.

No. Neither non-security hotfixes nor regulatory updates will be available for the Dynamics AX products during

the Extended Support phase of the product lifecycle (Dynamics AX 2009 SP1, Dynamics AX 2012, or Dynamics

AX 2012 R2).

While the ability to request a non-security hotfix for select products is included with Unified Support Advanced

and Performance Levels, Microsoft has determined that non-security hotfixes cannot be provided with a

commercially reasonable effort for these products. As a result, no requests for non-security hotfixes or

regulatory updates will be accepted. However, Microsoft will continue making security hotfixes, non-security

hotfixes, and regulatory updates for Dynamics AX 2012 R3 throughout that mainstream support period. The

source code for these non-binary, non-security hotfixes and regulatory updates will continue to be available for

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/mainstream-support-ax-2009-2012.md
https://support.microsoft.com/lifecycle/search?alpha=Dynamics AX
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/migration-upgrade/upgrade-home-page
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/migration-upgrade/upgrade-overview-2012
https://support.microsoft.com/lifecycle/search?alpha=Dynamics AX


I knew about the regulatory change before October 9, 2018, but it has the law enforcement date afterI knew about the regulatory change before October 9, 2018, but it has the law enforcement date after
October 9, 2018. Will I still get a regulatory update for Dynamics AX 2009 Service Pack 1, Dynamics AX 2012,October 9, 2018. Will I still get a regulatory update for Dynamics AX 2009 Service Pack 1, Dynamics AX 2012,
and Dynamics AX 2012 R2?and Dynamics AX 2012 R2?

A customer or partner can already download a fix through LCS and inspect the code by installing it into a testA customer or partner can already download a fix through LCS and inspect the code by installing it into a test
Dynamics AX 2012 R3 environment. Is there any difference with the approach that you have proposed?Dynamics AX 2012 R3 environment. Is there any difference with the approach that you have proposed?

What happens if a new bug is found by a customer in Dynamics AX 2009 Service Pack 1, Dynamics AX 2012, orWhat happens if a new bug is found by a customer in Dynamics AX 2009 Service Pack 1, Dynamics AX 2012, or
Dynamics AX 2012 R2?Dynamics AX 2012 R2?

How are binary hotfixes handled for Dynamics AX 2009 Service Pack 1, Dynamics AX 2012, and Dynamics AXHow are binary hotfixes handled for Dynamics AX 2009 Service Pack 1, Dynamics AX 2012, and Dynamics AX
2012 R2?2012 R2?

NOTENOTE

customers, and their partners, active on the Enhancement Plan or Software Assurance. Dynamics AX 2009 SP1,

Dynamics AX 2012, and Dynamics AX 2012 R2 customers can selectively integrate those changes as required.

Customers and partners can get the source code from packages attached to relevant Dynamics AX 2012 R3 KB

articles published on LCS and discoverable through LCS Issue Search.

No, we will only provide regulatory updates for Dynamics AX 2009 Service Pack 1, Dynamics AX 2012, and

Dynamics AX 2012 R2 for regulatory changes with the law enforcement dates on or earlier than October 9,

2018.

No, there is no difference.

The bug must be reproducible in Dynamics AX 2012 R3. If it is reproducible and accepted, then a hotfix will be

provided for Dynamics AX 2012 R3 and the customers can elect to integrate this hotfix in their version

themselves, or work with their partners to integrate the changes.

If a hotfix is needed for a part of the system where Microsoft does not provide the source code and it is not a

security bug, the hotfix will not be provided.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Help on docs.microsoft.com

Get notified about changes through an RSS feed

Users of the following apps can access context-sensitive Help and other content that is based on the same Help

system:

Microsoft Dynamics 365 Commerce

Dynamics 365 Finance

Dynamics 365 Human Resources

Dynamics 365 Supply Chain Management

In all these apps, you can access product-specific Help from the HelpHelp pane.

The docs.microsoft.com site (docs.microsoft.com/dynamics365) is the default source for product documentation

for the previously listed apps. This site offers the following features:

Access to the most up-to-date contentAccess to the most up-to-date content – The site gives Microsoft a faster and more flexible way to

create, deliver, and update product documentation. Therefore, you have easy access to the latest technical

information.

Content that is written by exper tsContent that is written by exper ts  – Content on the site is open to contributions by community members

both inside and outside Microsoft.

You can find content on docs.microsoft.com by using any search engine. For the best results, we recommend

that you use a site search, such as site:docs.microsoft.com dynamics 365 "search term"site:docs.microsoft.com dynamics 365 "search term".

To subscribe to a Really Simple Syndication (RSS) feed of all updates that are to the content on

docs.microsoft.com, use the following link:

RSS feed

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/help-overview.md
https://docs.microsoft.com/en-us/dynamics365/
https://docs.microsoft.com/api/search/rss?locale=en-us&$filter=scopes/any(t: t eq %27unified operations%27)


 

Leave us feedbackLeave us feedback
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Contribute to the documentation
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Task guides

If you have feedback or questions about a topic, leave us a comment at the bottom of the page.

1. Select FeedbackFeedback to get to the comments at the bottom of the page. Then, select either ProductProduct

feedbackfeedback or S ign in to give documentation feedbackSign in to give documentation feedback .

2. Start typing your comments, and then select Submit feedbackSubmit feedback .

If you want to submit documentation feedback, you must sign in by using a GitHub account. For more information, see

Setting up and managing your GitHub profile.

You can contribute and make edits to the documentation. To get started, select the EditEdit button (pencil symbol)

on a topic. The following video shows how you can contribute to our documentation.

The How to contribute to the Microsoft Dynamics 365 documentation video (shown above) is included in the

Microsoft Dynamics 365 channel on YouTube.

For more information, see the Docs contributor guide, which is published by the team that built the

docs.microsoft.com site.

We only accept contributions to our English content at this time.

A task guide is a controlled, guided, interactive experience that leads you through the steps of a task, or business

process. You can open (play) a task guide from the HelpHelp pane. When you first select a task guide, the HelpHelp pane

https://help.github.com/github/setting-up-and-managing-your-github-profile
https://www.microsoft.com/videoplayer/embed/RE36liB
https://youtu.be/m5djioozRbg
https://docs.microsoft.com/en-us/contribute
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In-product Help

will show the step-by-step instructions for the task. Localized task guides are available.

Microsoft released task guide libraries for product versions through the December 2017 release of Dynamics

365 for Finance and Operations. The Accessing task guides from the Help pane section of this topic explains how

to find the correct task guides for your product.

To begin the guided, interactive experience, select Star t task guideStar t task guide at the bottom of the HelpHelp pane. A black

pointer shows you where to go first. Follow the instructions that appear in the user interface (UI), and enter data

as directed.

The data that you enter when you play a task guide is real. If you're in a production environment, the data will be entered

in the company that you're currently using.

You can use Task recorder to create your own custom task guides. For more information, see Create

documentation or training with Task Recorder.

Some fields have field descriptions to help users get unblocked when they are uncertain about the data that the



  

Accessing Help topics from the Help paneAccessing Help topics from the Help pane

IMPORTANTIMPORTANT

Accessing task guides from the Help paneAccessing task guides from the Help pane

field contains, for example. Additionally, the in-product HelpHelp pane provides context-sensitive access to content

that can help users get started, get unblocked, and learn more.

To access Help content, select the HelpHelp button (??), and then select HelpHelp. Alternatively, press Ctr l+Shift+?Ctr l+Shift+?. In

both cases, the HelpHelp pane appears. From the HelpHelp pane, you can access conceptual topics or task guides that

are relevant to the area of the product that you're currently in.

From the HelpHelp pane, you can access topics that apply to the client. When you first open the HelpHelp pane, the HelpHelp

tab shows the topics that apply to the page that you're currently on. If no topics are found, you can enter

keywords to refine your search. When you select a topic in the HelpHelp pane, it's opened on a new tab in your

browser.

This section does not apply to Dynamics 365 Human Resources. The Help system for Human Resources is automatically

connected to task guides for the product. Also, you cannot create custom task guides for Human Resources.

Before you can access task guides from the HelpHelp pane, a system admin must configure some settings on the

System parametersSystem parameters  page in Finance, Supply Chain Management, or Commerce. For more information, see

Adding task guides.

After a System administrator has completed these steps, you can open the HelpHelp pane and select the TaskTask

guidesguides  tab. You'll now see the task guides that apply to the page that you're currently on. If no task guides are

found, you can enter keywords to refine your search. After you select a task guide in the HelpHelp pane, the HelpHelp

pane shows the step-by-step instructions, and you can play the task guide.



Where are the translated task guides for Microsoft libraries?Where are the translated task guides for Microsoft libraries?

Creating custom Help

Additional resources

SIT ESIT E DESC RIP T IO NDESC RIP T IO N

Docs.microsoft.com This site hosts or links to all product documentation for
Dynamics 365.

Microsoft Learn This site is the free Microsoft eLearning site.

Translated task guides are released in libraries that have "All languages" in the title. To view localized task guide

Help, make sure that you're connected to an appropriate library. Each user can change the language that a task

guide appears in by changing the language settings under OptionsOptions  > PreferencesPreferences .

If a task guide has been translated, when you open that task guide all the text of the task guide will appear in

your selected language.

If a task guide has not yet been translated, when you open it, only the text of the controls will appear in your

chosen language.

You can create Help for your users by creating custom task guides or connecting your own website to the HelpHelp

pane. For more information, see the following topics:

Task recorder resources

Custom Help overview

The following table lists our websites. Sites that have an asterisk (*) next to the name require that you sign in by

using an account that is associated with a service plan.

https://docs.microsoft.com/en-us/dynamics365/
https://docs.microsoft.com/en-us/learn/


Microsoft Dynamics Lifecycle Services (LCS)* This site provides a cloud-based collaborative workspace
that customers and partners can use to manage projects
from pre-sales to implementation and operations. It's useful
in all phases of an implementation.

Support blog This site provides tips and tricks that are posted by the
Support team.

Docs.microsoft.com/previous versions This site hosts content from previous releases.

Dynamics Community This site hosts blogs, forums, and videos.

Microsoft.com/dynamics365 This site provides evaluation and sales information.

CustomerSource* This site hosts training resources, downloadable reports, and
white papers, and is the primary support site for service plan
holders. Access to some resources on this site might require
a service plan.

SIT ESIT E DESC RIP T IO NDESC RIP T IO N

NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://lcs.dynamics.com/
https://aka.ms/AXSupportBlog
https://docs.microsoft.com/en-us/previous-versions/dynamics/
https://community.dynamics.com/
https://www.microsoft.com/dynamics365/home
https://docs.microsoft.com/en-us/dynamics/s-e/
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


  

Configure the Help experience for Finance and
Operations apps
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Help architecture

Adding task guides

NOTENOTE

In this topic, you will find an overview of the components of the Help system for Finance and Operations apps,

such as Microsoft Dynamics 365 Finance, Dynamics 365 Supply Chain Management, Dynamics 365 Commerce,

and Dynamics 365 Human Resources. The topic also explains how to connect these components and provides a

summary of the process for creating custom Help.

Finance and Operations apps include conceptual overviews and other topics that are published to the

https://docs.microsoft.com/dynamics365 site. This content can then be accessed from the in-product HelpHelp pane.

The following illustration shows the parts of the Help system.

The in-product Help system pulls articles from docs.microsoft.com and other connected websites. It also pulls in

task guides that are stored in Business process modeler (BPM) in Microsoft Dynamics Lifecycle Services (LCS).

The Task guidesTask guides tab isn't currently available in Human Resources or Commerce. However, the task guides in the Getting

Started experience in Human Resources remain available to cover basic functionality. For both Human Resources and

Commerce, procedural Help is available on the https://docs.microsoft.com/dynamics365 site.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/help-connect.md
https://docs.microsoft.com/en-us/dynamics365/
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/media/help-architecture.png
https://docs.microsoft.com/en-us/dynamics365/
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IMPORTANTIMPORTANT

Showing translated task guidesShowing translated task guides

On the System parametersSystem parameters  page, system admins can configure access to the relevant task guide libraries for

an implementation.

To configure Help, you must sign in by using an account in the same tenant as the tenant where the app is deployed.

An LCS library can't be connected from an instance of the app that is running on a local virtual hard drive (VHD).

To configure task guides for a solution, follow these steps on the System parametersSystem parameters  page.

The first time that you open the HelpHelp tab, you must connect to Lifecycle Services. Be sure to select the link in the middle

of the form, wait for the connection, close the dialog box, and then select OKOK to get to the System ParametersSystem Parameters  page.

1. Select the Lifecycle Services project to connect to.

2. Select the BPM libraries (within the selected project) to retrieve task recordings from.

3. Set the display order of the BPM libraries. The display order defines the order in which task recordings from

the libraries will appear in the HelpHelp pane.

After you complete these steps, you can open the HelpHelp pane and select the Task guidesTask guides  tab. You'll now see the

task guides that apply to the page that you're currently on in Finance and Operations apps. If no task guides are

found, you can enter keywords to refine your search.

Translated task guides were first released in the May 2016 APQC Unified Library and in the Getting Started

library. To view localized task guide Help, make sure that your Dynamics 365 solution is connected to the May

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/media/system-parameters_ops.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/media/connect-to-lcs-crop.png
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Adding custom Help

Create custom Help by using task guidesCreate custom Help by using task guides

Connect a custom Help siteConnect a custom Help site

See also

NOTENOTE

2016 library. Users can change the language that a task guide appears in by changing the language settings

under OptionsOptions  > PreferencesPreferences .

Although many task guides have been translated, the client doesn't currently show the translated task guide names.

Additionally, in the May 2016 library, translations are available only for the task guides that were released in February

2016. Microsoft will release an updated library that includes additional translations.

If a task guide has been translated, when you open that task guide all the text of the task guide will appear in your

selected language.

If a task guide has not yet been translated, when you open it, only some of the text (the text of the controls) will

appear in your selected language.

You can use task guides to create custom Help, or you can connect a custom Help website to the HelpHelp pane.

You can create custom Help for the supported apps by creating task recordings that reflect your implementation

and then saving them to a Business process library in LCS. You can't create custom task guides for Human

Resources.

If you're a partner, and you promote a library to a corporate library and include it in a solution, it will be

available to your customers. You can also make a copy of the APQC Unified Library, and then open the task

recordings in the copy, edit them, and save your changes. For more information, see Task recorder resources.

Finance and Operations apps are rarely used in their out-of-box form. Instead, the solution is customized and

extended to fit the organization's needs. You can also customize and extend the Help experience. For example,

you can add custom Help to the in-product HelpHelp pane.

Microsoft has provided a toolkit to help you deploy and connect custom Help to the HelpHelp pane. For information

about how you can set up a custom Help solution that is connected to the HelpHelp pane, see Custom Help

overview.

If you want to collaborate with Microsoft on tools and processes for customizing Help, fill in the form at

https://aka.ms/customhelpfeedback.

Help system

Custom Help overview

Task recorder resources

Create documentation or training with Task Recorder

Custom Help GitHub repository

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/customhelpfeedback
https://github.com/microsoft/dynamics356f-o-custom-help
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Custom Help content

Finance and Operations apps are often customized and extended to fit an organization's needs. If your solution

is based on Microsoft Dynamics 365 Finance, Dynamics 365 Supply Chain Management, or Dynamics 365

Commerce, you can connect solution-specific and customer-specific Help content to the Help pane in the

Finance and Operations client. This topic describes the main steps and decision points.

Users of Finance and Operations apps can create custom task guides to supplement conceptual content that describes

the functionality of their solution. These conceptual descriptions are also referred to as Help and can be provided by

Microsoft, partners, and an organization itself. For more information, see Help system.

The following illustration, and this topic in general, use the term Help for conceptual descriptions that either

include or exclude how-to guides. The term task guides refers to in-product task guides.

Custom Help content typically originates from one of three sources:

Microsoft documentation repositories (repos)

You can use the HTMLFromRepoGenerator tool from the Custom Help Toolkit to clone content from any

of the Finance and Operations repositories and generate corresponding HTML files. Those files can then

be updated with content that is specific to your solution.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/help/custom-help-overview.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/help/custom-help-toolkit-htmlfromrepogenerator
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I want to give my users a customized in-product Help
experience that reflects their actual solution.

See the Custom Help websites section of this topic and
Create documentation or training with Task Recorder.

I want to use the Microsoft Help content as a baseline for
Help content that is specific to my solution.

See Custom Help Toolkit: The HtmlFromRepoGenerator tool.

I want to contribute to the Microsoft Help content. See Extend, customize, and collaborate on the Help.

I want to reuse my existing Dynamics AX content. See Convert Dynamics AX custom Help for use in Dynamics
365.

I want to set up a website for my Help content. See the Custom Help websites section of this topic.

I want to add my content to the HelpHelp pane. See Connect a custom Help website to the Help pane.

Our technical writers want guidance that will help them
convert our earlier content into Markdown so that it
becomes easier for them to customize the Microsoft content.

See Moving to Markdown.

Custom Help websites

Existing customized Dynamics AX content

You can convert Dynamics AX custom Help content so that it can be used in Dynamics 365.

HTML files that are created specifically for your solution

Learn more about the metadata that must be added to your HTML files for context-sensitive Help and

search to work correctly.

The end-to-end process depends on the actual customer solution and the users' expectations. A typical process

involves the following steps:

1. Create the custom Help content.

2. Publish the content on a website.

3. Index the content by using a search service.

4. Connect the custom HelpHelp pane to the website and the search service.

Microsoft provides a toolkit that can help you generate HTML files from the Microsoft Help repositories,

generate JavaScript Object Notation (JSON) files for search services, and change the locale of HTML files so that

it matches the locale of your solution.

You're welcome to share your knowledge by contributing to this documentation through the link at the bottom

of the page or by joining the Dynamics 365 community.

The following table outlines the main objectives that admins typically have for configuring the Help experience.

Before the product can connect to your Help content, you must customize the in-product HelpHelp pane so that it

shows your content. The following conditions must be met:

Your content must be available on a website.

You can deploy your content to an existing website, or you can set up a dedicated website to host your

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/help/migrate-dynamicsax2012
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/help/preparing-content
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/help/custom-help-toolkit
https://community.dynamics.com/
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/help/custom-help-toolkit-htmlfromrepogenerator
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/help/contributor-guide
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/help/migrate-dynamicsax2012
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/help/connect-help-pane
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/help/migrate-dynamicsax2012
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content. The website can be private or public, but we recommend that users notnot be required to sign in to

access your content.

Your content must be indexed by a search service.

If you use the AzureSearchCustomHelp solution that is part of the Custom Help Toolkit for context-

sensitive Help, the HelpHelp pane will generate a query that must be run against the search service's index.

The query depends on specific metadata in the Help topics. For more information, see Metadata

requirements for custom Help topics.

The Deploy custom Help to Azure topic describes an approach for hosting content on Azure. It includes

information about how to set up a search service that indexes your content so that it can be found by the in-

product HelpHelp pane. If you don't have an Azure subscription, create an account before you begin. You can start

with a free account for 12 months. For more information, see Create your Azure free account today.

Connect a custom Help website to the Help pane

Deploy custom Help to Azure

Custom Help Toolkit

Language and locale descriptors in the product and in Help

Configure the Help experience for Finance and Operations apps

Help system

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/help/walkthrough-help-azure
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/help/custom-help-toolkit
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/help/preparing-content
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/help/walkthrough-help-azure
https://docs.microsoft.com/en-us/azure/guides/developer/azure-developer-guide#understanding-accounts-subscriptions-and-billing
https://azure.microsoft.com/free/
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/help/connect-help-pane
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/help/walkthrough-help-azure
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/help/custom-help-toolkit
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/help/language-locale
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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See field descriptions in the user interface
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Use the Field descriptions page to view and export field help

View the descriptions for a pageView the descriptions for a page

This article describes how to view field descriptions and how to use the Field descriptions page to export

descriptions.

Some of the more complex fields have field descriptions. These descriptions appear when you hover over a field.

You can also view and export descriptions on the Field descr iptionsField descr iptions  page.

Not all pages have field descriptions. We want to provide descriptions only for the more complex fields, not

where the use of the field is obvious. Therefore, some pages don't have any field descriptions, some pages have

a few descriptions, and some of the more complex pages, such as many of the parameters pages, have many

descriptions.

If you have access to the development environment, you can add new field descriptions and customize existing

descriptions. For example, you can add company-specific information to a field description. For more

information, see Customize field descriptions.

You can view field descriptions by hovering over a field. If no description is available, you see the field name

when you hover over the field.

In Dynamics AX 7.0 (February 2016), field descriptions can be viewed only on the Field descriptionsField descriptions page.

The following illustration shows the field description that appears when you hover over the Lock items duringLock items during

countcount field.

The Field descr iptionsField descr iptions  page lets you view and export field descriptions. You can see the descriptions that are

available for one page at a time.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/view-export-field-descriptions.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/user-interface/customize-field-help
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/media/field-description.png


Export the descriptions for a pageExport the descriptions for a page

Searching for a pageSearching for a page

Troubleshooting

I can't find a field descriptionI can't find a field description

The field description isn't helpfulThe field description isn't helpful

To view the descriptions for a page, follow this step.

In the Select a pageSelect a page field, type the name of the page. Alternatively, click the arrow to open a list of all the

pages, and then browse or filter the list.

You can use either the name of the page that is shown in the user interface (UI) (for example, CustomersCustomers ) or the

code name (AOT name) that's available when you right-click a page (for example, CustTableCustTable).

For information about the various ways to filter the list of pages, see the "Searching for a page" section later in

this article.

If you set the Include fields without a descr iptionInclude fields without a descr iption option to YesYes , all the fields on the page are shown, even if

they don't have a field description.

To export the descriptions for a page, follow these steps.

1. In the Select a pageSelect a page field, select a page.

2. Click the Open in Microsoft OfficeOpen in Microsoft Office button in the upper-right corner, and then click FieldDescr iptionTmpFieldDescr iptionTmp.

There are several ways to search for a page in the Select a pageSelect a page field. In many cases, you must click the arrow

in the Select a pageSelect a page field to open the drop-down list, and then select from a filtered list of pages.

Type part of the name, and then open the drop-down list to select from a filtered list of pages.

Open the drop-down list, and then click either the Page namePage name heading at the top of the list or the PagePage

AOT nameAOT name heading. A dialog box appears, where you can use advanced filtering options, such as PagePage

name begins withname begins with .

Type the full name of the page. When you use this option, it's best to open the drop-down list and see

what else is in the list, even if field descriptions are shown.

If there is a single exact match to the name, the field descriptions for that page are shown.

If there is more than one exact match, no descriptions are shown. You must open the drop-down list

and select the page that you want.

If the name that you typed is part of the name of another page, you see the descriptions for your page.

However, if you open the drop-down list, you see additional pages that contain that name.

For example, no descriptions are shown when you type CountingCounting in the Select a pageSelect a page field. You open the

drop-down list, and see that there are two pages that have the name CountingCounting and several pages that contain

the word "Counting" in the name. If you select the page that has the AOT name InventJournalCountInventJournalCount, the field

descriptions are shown for that page. However, if you open the drop-down list again, you will see that the list

now contains all pages that have "InventJournalCount" as part of their AOT name.

This section provides information to help you troubleshoot issues that you might encounter when you use field

descriptions.

We're in the process of adding descriptions for the more complex fields. If you require help for a particular field,

let us know by adding a comment for this topic.

Let us know by adding a comment for this topic. If you can, describe the additional information that you require.



I can't find a field on the Field descriptions pageI can't find a field on the Field descriptions page

I can't find a page on the Field descriptions pageI can't find a page on the Field descriptions page

Additional resources

NOTENOTE

To show all the fields on a page, set the Include fields without a descr iptionInclude fields without a descr iption option to YesYes . Click the SelectSelect

a pagea page field to verify that you've selected the correct page. If the name that you typed is part of another field

name, you might have selected the page that has the longer name.

For information about the various way to find pages, see the "Searching for pages" section earlier in this article.

If you've typed the exact name of the page, the field descriptions might not be shown if more than one page has

the same name. Click the arrow in the Select a pageSelect a page field to open a filtered list of the pages that are available.

Customize field descriptions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/user-interface/customize-field-help
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Overview
Task recorderTask recorder

ArchitectureArchitecture

Basic configurationBasic configuration

IMPORTANTIMPORTANT

Start a new recording

This topic describes how to use Task recorder to record business processes.

Task recorder for Finance and Operations apps is a utility that lets users record business processes for several

different use cases. Here are some examples:

Step-by-step guided tours of a specific business process in the application itself

Documentation of a business process as a Microsoft Word document that can optionally include screenshots

Regression tests for a business process

Automatic playback of a business process in the application

Task recorder for Finance and Operations apps boasts high responsiveness, a flexible extensibility application

programming interface (API), and seamless integration with consumers of business process recordings. Task

recorder is also integrated with the Business process modeler (BPM) tool in Microsoft Dynamics Lifecycle

Services (LCS), so that users can continue to organize their recordings. However, users can no longer produce

business process diagrams from recordings.

Task recorder can automatically generate application regression tests from business process recordings and play

back previously recorded processes. These features also include test-specific gestures that let users take full

advantage of Task recorder.

Task recorder can record user actions in the client with exact fidelity, because every control is instrumented to

notify Task recorder about the execution of user actions. The control notifies Task recorder that an event has

occurred and passes all the relevant information about the corresponding user action in real time. From this

information, Task recorder can capture the type of user action (for example, a button click, value entry, or

navigation) and any data that is related to the user action (for example, the input data value and type, form

context, or record context). Task recorder persists the information with enough detail to ensure that a playback

of the recording can run the recorded actions exactly as they were performed by the user.

Task recorder is included with every Finance and Operations app, and lets users begin to record business

processes immediately after they open the client for the first time.

The Task guidesTask guides tab is currently not available in Commerce or Human Resources. We are currently working to enable this

functionality in a future release. Task guides in the Getting Started experience in Human Resources remain available to

cover basic functionality. Procedural help is also available on the docs.microsoft.com site

(https://docs.microsoft.com/dynamics365/) for both Commerce and Human Resources.

The following steps show how to use Task recorder to start a new recording.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/user-interface/task-recorder.md
https://bpm.lcs.dynamics.com
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/index


Record a Fleet Management scenarioRecord a Fleet Management scenario

NOTENOTE

1. Open the product, and sign in. It's a good practice to refresh the browser before each new recording. A

refresh creates a new user session and restarts Task recorder. Therefore, it provides the most stable

recording experience.

2. Select the company that you want to use while recording. If this is your first time using Task recorder, you

can follow along as this tutorial creates a sample recording based on a Fleet Management business

process. You will need to load the Fleet demo data to follow along:

a. Go to Dashboard > Fleet Management > Fleet setupDashboard > Fleet Management > Fleet setup.

b. Click Load demo dataLoad demo data.

c. When the data is finished loading, click CloseClose.

d. Go back to the DashboardDashboard by clicking the product name in the navigation bar.

3. Go to Settings > Task recorderSettings > Task recorder .

4. The Task recorderTask recorder  pane is opened. You can click the CloseClose button (XX) in the upper-right corner to close

the Task recorderTask recorder  pane before you begin a new recording. You can reopen the pane by following the

previous steps.

5. Click Create recordingCreate recording.

6. Enter a name for the recording and click Star tStar t. Recording begins the moment Star tStar t is clicked. For the

Fleet example in this tutorial, we'll use the name "Create a new rental reservation."

While you're recording, you can click the CloseClose button (XX) in the upper-right corner to hide the TaskTask

recorderrecorder  pane without stopping the recording. You can reopen the pane by clicking the Task recorderTask recorder

button that appears at the top of the page. This button appears only while recording is in progress.

If the Saved viewsSaved views feature is turned on, recordings should be created by using either published views or the

standard view, to ensure that recordings work reliably for users.

7. Task recorder enters recording moderecording mode. The pane shows information and controls that are related to the

process of recording.

Now you're ready to record a business process using Task recorder. If you're following this guide as a first-time

user, you may complete the following Fleet Management scenario as an example. Otherwise, you can record

your own application scenario.

1. In the Task recorderTask recorder  pane, click Star t sub-taskStar t sub-task .

2. Set NameName to "Create a new rental customer". Leave the CommentComment field blank.

3. Click OKOK. The task is added to the step list.

4. Go to Dashboard > Fleet Management > Reser vation ManagementDashboard > Fleet Management > Reser vation Management.

5. Go to All customersAll customers  under the Summar ySummar y  tab.

6. In the Action Pane, click NewNew .

7. Enter a first and last name for the customer.

8. Click SaveSave.

9. In the Task recorderTask recorder  pane, click End sub-taskEnd sub-task .

10. Return to the Reser vation ManagementReser vation Management workspace by clicking the browser back button twice.

11. In the Task recorderTask recorder  pane, click Star t sub-taskStar t sub-task . Name the task "Rent a vehicle to the new customer". Click

OKOK.

12. Click (++) RentalRental  under Summar ySummar y .



Recording a business process

StopStop

Start/End sub-taskStart/End sub-task

NOTENOTE

Delete/Restore stepDelete/Restore step

13. Under InformationInformation, select a "1975 Litware McKinley" as the vehicle.

14. Under InformationInformation, set the customer to the one just created.

15. Expand the DiscountsDiscounts  section.

16. Click AddAdd under DiscountsDiscounts  and add the Frequent Customer discount. Click OKOK.

17. In the Action Pane, click Star t RentalStar t Rental .

18. Set the return date to some date in the future.

19. Click OKOK.

20. In the Task recorderTask recorder  pane, click End sub-taskEnd sub-task .

21. Click StopStop at the very top of the page.

After you've started your recording, you can perform your business process just as you would typically perform

it by using the web client. As you interact with the product, new steps are added to the step list in the TaskTask

recorderrecorder  pane. In this section, you will learn about other actions that you can perform while you're recording a

business process, to take full advantage of Task recorder's capabilities.

StopStop is used to end the recording session. Before you click StopStop, you should make sure that the recording is

completed, because this action isn't reversible. When you click StopStop, you're taken to the download options

screen.

Star t/End sub-taskStar t/End sub-task lets a user specify the beginning and end of a set of grouped steps in a recording. Click the

Star t sub-taskStar t sub-task button to add a "Sub-task" step to the end of the current list of recorded steps. The sub-task will

include all steps that you perform from this point until you click the End sub-taskEnd sub-task button. When you click the

End sub-taskEnd sub-task button, an "End sub-task" step is also added to the list of recorded steps.

You must start a sub-task before you perform/record the steps that you want to include in the task. Then, after you've

performed/recorded all the steps that you want to include in the task, you must end the sub-task.

Sub-tasks are purely an organization tool, and consumers of business process recordings can interpret the task

groupings in useful ways. Because tasks can be nested inside other tasks, they provide the flexibility to organize

very long and complex business processes.

Delete/Restore stepDelete/Restore step enables a user to remove steps from the recording, or undo the removal of a step from

the recording. You must first select the step in the Steps list that you want to delete/restore, and then click the

Delete/Restore stepDelete/Restore step button.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/user-interface/media/taskrecorderguide-taskrecordertoolbarstop.png


NOTENOTE

Add developer placeholderAdd developer placeholder

Enriching steps in a recording

Step instructionStep instruction

The behavior of the DeleteDelete button changes when you play back a recording. In playback mode, a deleted step can't be

restored after playback has passed the point where it would have run the deleted step. For example, you load a recording

that contains three steps, and then you delete step 2 before you start playback. You can restore step 2 only as long as

playback hasn't run step 3. After you start playback, and playback has "skipped" step 2 (because you deleted it) and run

step 3, you won't be able to restore step 2. Because step 2 wasn't run and therefore wasn't recorded, it can't be

retroactively added back into the recording at its previous position.

Add developer placeholderAdd developer placeholder  lets the user add a placeholder step to the list of recorded steps. This placeholder

step doesn't appear when the task guide is viewed, and it isn't run during maintenance of a recording. It's used

only by the Regression suite automation tool (RSAT) or the X++ code generator that enables an X++ test to be

created from a task recording. When the code generator creates an X++ test, it automatically adds a method

stub to the generated code. The developer can then add X++ code into this method stub. The automated code

will call the validation when the generated test is run at the point in the recording where this placeholder was

added.

There are various options for enriching a step in a recording. For example, you can adjust the text that is

associated with a step and add information about a specific step. This section describes the step enrichment

capabilities that are available. To access these options, click the Edit stepEdit step button on a specific step of a

recording.

The Step instructionStep instruction is the primary text that is displayed for this step in the task guide. There are usually 2-3

alternative options for step instructions, and they appear in the following order when editing the annotation.

This image shows the annotation options for changing a step.

NOTENOTE

Preferred value instructionPreferred value instruction This type of instruction will direct the user to enter the same data that was

used when the step was recorded. Example: In the First name field, enter 'John'.

Example value labelExample value label  This type of instruction will direct the user to enter their own data, indicating that

the data that was used when the step was recorded was only Example data. Example: In the First name

field, enter a value.

If users click the See moreSee more button on this step when they play the recording as a task guide, they will be

able to see the data that was used when the step was recorded. This recorded data value will be labeled

as an Example data value.

Steps that are not related to fields, such as clicking buttons, opening forms, or selecting records from a lookup, do

not set Example value label as an option when annotating.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/perf-test/rsat/rsat-overview
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/user-interface/media/taskrecorderguide-annotationlabels.png


Titles and notesTitles and notes

Change recorded valuesChange recorded values

Hide from task guideHide from task guide

Using control gestures

CopyCopy

PastePaste

User-supplied value labelUser-supplied value label  This step instruction contains placeholder text, which the author can fill in

with their own text. For steps which have an Example value labelExample value label  option, the placeholder allows

substituting the text which normally specifies the data to enter. This is useful for scenarios where neither

the Preferred value labelPreferred value label  nor the Example value labelExample value label  sufficiently express the data that should be

used for this step.

Example label: In the First name field, enter {your example text}.

Example label after supplying the placeholder text: In the First name field, enter the customer's name.

For steps which do not have an Example value labelExample value label  option, the placeholder allows substituting all of

the label text. Steps associated with buttons, for example, do not have Example value labelsExample value labels , so you

may replace the entire label text with your own text.

Example label before replacement: Click Post.

Example label after replacement: To post the order, click Post.

Titles and notes provide places for user-specified text to be associated with a step in a task guide.

TitleTitle – The title lets you specify the text that appears above the step instruction for this step in the task guide.

The title a good place to put text that you want users to read before they complete the action that is indicated

by the step instruction.

NoteNote – You can use a note to specify text that appears in the expandable section of the pop-up for this step in

the task guide. A note is a good place to put optional reading material or other information that might be

useful to users, but that they aren't required to read to complete the action that is indicated by the step

instruction.

Starting in version 10.0.12, you can adjust the values that are recorded in basic input controls (for example,

simple text, numeric, date, and picklist fields), without having to re-record those steps. Note that lookup controls

and reference groups aren't currently supported.

The Hide this stepHide this step option lets the author prevent specific steps from appearing in the task guide. This option is

useful for hiding steps that are required for the task recording to run in playback mode, but that should not be

seen by users. Examples of these steps include copy steps, system-generated steps, and data clean-up steps. If

you hide a sub-task, all the steps that are recorded inside that sub-task will also be hidden.

The basic recording capability lets a user record an end-to-end business process by using Task recorder, but

without adding overhead to the process. In some circumstances, more advanced recording features can be used

to create even richer business process recordings. Each of the following gestures is found under the TaskTask

recorderrecorder  option on the shortcut menu (also known as a right-click menu or context menu) for a control and

causes a step to be added to the recording. If the gesture isn't supported for a control, it won't appear on the

shortcut menu for that control.

The CopyCopy  gesture lets you copy the value for the current control to the Task recorder "clipboard." That value can

then be used later as part of a PastePaste or ValidateValidate gesture. Because values from multiple controls might have to

be pasted, the Task recorder clipboard maintains a list of all control values that have been copied in the

recording.

The PastePaste gesture lets you paste a value from a previous CopyCopy  gesture in the same recording. The Task recorder



ValidateValidate

Add info stepAdd info step

NOTENOTE

paste function works like the standard paste function that users might be familiar with, but it has an additional

benefit when it's used during recordings. Because Task recorder will replay the recorded CopyCopy  and PastePaste

commands during playback, if the copied control has a different value than it had during recording, Task

recorder will paste the current value instead of the value that the copied control had during recording. This

feature is useful in scenarios where the copied control has a value that can change between environments (for

example, recID values or number sequences).

There is an additional benefit from using the CopyCopy  and PastePaste gestures when test code is generated. For any

control where the value is set via the PastePaste command, Task recorder doesn't have to create a parameterized

input variable for that control's value, because it's set based on another control's value. This feature can be very

useful in scenarios where an entity such as a customer is created, and an identifier for that entity is frequently

entered during the recording. Instead of manually re-entering the customer name or ID throughout the scenario,

and causing Task recorder to generate a parameterized input variable for each entry, the user can copy the

customer name or ID one time, and then repeatedly paste it. In this case, Task recorder will generate a single

parameterized input variable to represent the customer name or ID. This feature can make it much easier to

change the input data for a generated test.

The ValidateValidate gesture lets you insert a step that validates the value of the targeted control. This gesture always

uses equality to validate the control value. Validations aren't currently run during recording playback. Instead,

they are run only when the generated test code is run. Two kinds of validation are available:

Current value validationCurrent value validation will capture the targeted control's value at the time of recording and use it to

generate an assertion in the test code. In the list of validation options on the shortcut menu, Current valueCurrent value

is always first.

Reference value validationReference value validation will use the value of a previously copied control when generating an assertion

in the test code. This allows creating assertions that are resilient to changes in the data, since the value is not

hardcoded into the test code. In the list of validation options on the shortcut menu, Reference valueReference value

validationvalidation follows the format [AOT name of copied control: current copied value].

Additional options are available in version 10.0.13 and later. Here are some examples:

EnabledEnabled/DisabledDisabled validates that the targeted control's state is enabled (or disabled), and then uses that

validation step to generate an assertion in the test code.

Read-onlyRead-only/EditableEditable validates that the targeted control's state is read-only (or editable), and then uses that

validation step to generate an assertion in the test code.

The Add info stepAdd info step gesture lets you insert a step and supply your own text for it. This feature is useful primarily

for creating task guides. An informational stepinformational step (or info stepinfo step for short) is a task guide step where the

instruction text for the step is user-specified. Info steps are useful for describing actions that are a part of the

scenario but must occur outside the client. For example, a scenario might require the user to search for item

inventory or check an email for information.

You can specify where an info step should appear in the task guide. The info step can point to a control on the

page, if the step is associated with the control. Alternatively, the info step can appear in the upper right of the

page, if the step is external to the client, or if it's an explanation that applies to the whole page.

Because info steps are manually specified steps and are not automatically recorded by Task recorder when the user takes

an action on a control, the info step does not have the capability to automatically progress when a user completes the

step in the task guide. Because the info step is not associated with taking an action in the client, there is no action for a

task guide to detect that the user has completed in order to automatically progress to the next step.



Options after a recording is completed

Save to this PCSave to this PC

Save to Lifecycle Services (LCS)Save to Lifecycle Services (LCS)

NOTENOTE

Export as Word documentExport as Word document

Save as developer recordingSave as developer recording

Playing back a recording

After you click StopStop to end your recording session, several options are shown so that you can save the files that

are related to the completed recording. Select Save to this PCSave to this PC , and save the task recording package to your

desktop. You will use this file later.

One option after you finish your recording is to download the task recording package (an .axtr file) to your

computer. This file can be loaded later via the Task recorderTask recorder  pane, so that the recording can be played as a task

guide or edited.

When you save your recording to an LCS library, it's published on the specified business process in a BPM

library. If the selected LCS library is set as a Help library, you will be able to find the task guide for the recording

by searching the HelpHelp menu.

To be able to save a recording to an LCS library, the user must be in the Azure Active Directory (Azure AD) tenant that the

environment was deployed from.

The Microsoft Word document for your recording contains the recorded steps as well as any screenshots that

were captured.

The raw recording file (developer recording) is useful for developer scenarios, such as test code generation and

scenarios where RSAT is used.

The playbackplayback functionality of Task recorder can automatically run the steps of an existing recording by using

the pages and values that were originally recorded. Playback mode can be used to update an existing recording

if changes were made to the underlying application, and those changes altered the business process steps that

are required for the scenario. It's important to remember that, in this mode, Task recorder simultaneously re-

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/user-interface/media/taskrecorderguide-taskrecorderdownloadoptions.png
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/perf-test/rsat/rsat-overview


Play next pending stepPlay next pending step

Play all pending stepsPlay all pending steps

Play to selected stepPlay to selected step

Editing a recording

records the steps and plays them back. When the playback is completed, a new recording is produced that

reflects both the steps that were run from the existing recording and any new steps that the user manually

performed. Any steps that aren't run either by the user or automatically by Task recorder aren't included in this

new recording.

To play back an existing recording, follow these steps.

NOTENOTE

1. Refresh the browser tab.

It's a good practice to refresh the browser before each new recording.

2. Open the Task recorderTask recorder  pane.

3. Click Playback recordingPlayback recording.

4. Click Open from this PCOpen from this PC to load a recording from a previously downloaded Task recorder package (.axtr

file).

If you're reading this guide for the first time and following along, choose the "Create a new rental

reservation" file that you downloaded previously.

5. Click Star tStar t.

When you play back a recording, additional actions are available in the Task recorderTask recorder  pane.

Play next pending stepPlay next pending step runs the next step in the recording. This action is useful because it gives you more

control over the playback speed when you want to analyze the effects of a single step. This action has a side-

effect that it's important to be aware of. When you click Play next pending stepPlay next pending step, any open lookups, drop-

down dialog boxes, or Action Pane tabs might be dismissed, because this action removes focus from those

elements. For these situations, we recommend that you use Play all pending stepsPlay all pending steps  instead.

Play all pending stepsPlay all pending steps  begins sequential execution of the remaining steps in the recording, and continues

until either playback is paused or all steps have been run. During playback, the Play all pending stepsPlay all pending steps  button

is replaced by a PausePause button that can be used to pause playback. If playback can't successfully run a step for

any reason (for example, because it can't find a button that has been renamed), Task recorder will skip that step,

and playback will automatically be paused. In this way, the user has an opportunity to replace the obsolete step

by completing the new steps in the client. Task recorder will record the new steps and ignore the step that was

skipped. The user can then click Play all pending stepsPlay all pending steps  to continue playback for the remaining steps. After the

recording is completed, the user can download the updated recording. This recording will contain all the steps of

the original recording, but will exclude any skipped steps and include any new steps.

Play to selected stepPlay to selected step behaves like Play all pending stepsPlay all pending steps , but it lets you play only a subset of the steps

instead of all the steps. In the list, select the step that you want playback to stop at, and then click Play toPlay to

selected stepselected step. Task recorder will begin to run the steps in the list and will stop when it has run the step that you

selected.

Although you can edit a recording through the playback functionality, there is also a mode that lets you make

simple edits to a recording without having to replay the whole recording. To access this feature, click EditEdit

recordingrecording after you open the Task recorderTask recorder  pane. You can use this feature to make the following edits:



Insert steps without re-recording the entire fileInsert steps without re-recording the entire file

Move steps under a sub-task without re-recording the entire fileMove steps under a sub-task without re-recording the entire file

Insert steps into a recording without re-recording the whole file.

Move steps under a sub-task without re-recording the whole file.

Adjust the name and description of the recording.

You can add a step anywhere in a task recording without playing back or re-recording the whole file.

1. Select the step after which you want the new step to be inserted. Make sure the step is highlighted.

In order for task recorder to insert a step, you must have the correct page open. The correct page is the

page on which the new step occurs. Task recorder has a mechanism that determines what the active page

is, and will disable the functionality if the correct page isn't open.

When you are on the correct page, Inser t stepInser t step becomes available.

2. Click Inser t stepInser t step.

When you click Inser t stepInser t step, Task recorder switches to recording mode. Any action that is performed in

the user interface (UI) will now be recorded and inserted into the recording as steps.

3. Click StopStop.

Recording mode is stopped, and you can now continue to edit the recording. For example, you can repeat

this process to insert steps in other places in the recording, or you can move sub-tasks as described in

the next section.

4. When you've finished editing the task recording, click Done editingDone editing, and then select one of the options

to save or publish the recording.

You can move steps under a sub-task without playing back or re-recording the entire file. You can also move the

sub-task step or the end sub-task step if you want to group an existing block of steps.

1. Select the step or sub-task step that you want to move. Make sure that the step is highlighted.

2. Click Move step afterMove step after . To access this command, you might have to select the ellipsis (......) button.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/user-interface/media/taskguide1.png
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Adjust the recording name and descriptionAdjust the recording name and description

Playing a task guide

NOTENOTE

3. Select the step or sub-task step that you want to move the step or sub-task step after. Task recorder will

move the step.

4. To move the end sub-task step, select it, click Move step afterMove step after , and then select the step that you want the

end sub-task step to be after.

If you want the first step in the task guide to be within a sub-task, create a sub-task step as the second

step, and then move the first step into it. You can add or move as many steps or sub-tasks as needed.

5. When you've finished editing the task recording, click Done editingDone editing, and then select one of the options

to save or publish the recording.

You can adjust values of the Recording nameRecording name and Recording descr iptionRecording descr iption fields. If you want to see more

steps in the Task recorder editing pane, you can also collapse the section that shows the recording name and

description.

A task guidetask guide is a user-focused experience that lets the user follow a guided step-by-step set of instructions to

complete a business scenario by using a task recording. The user is instructed to complete each step through an

animated pop-up prompt that will move across the page and point to the UI element that the user should

interact with. The prompt will also tell the user how to interact with the element. For example, it might state,

"Click here" or "In this field, enter data." Each step that the user is instructed to complete is based on a step that

was originally recorded in the task recording. Because the task recording file contains the data that describes the

step that was originally recorded, the task guide can automatically determine when the user has completed the

step as expected. It then automatically moves on to the next step.

One way that the task guide determines that a user has completed a step is by detecting when the value in a field has

changed. Although the task guide doesn't require that a specific value be set, it does require that the field value be

changed in order to determine that the step was completed. The user must change the field value, and then press the TabTab

key or click in an area outside the UI element. Only at that point does the client detect that the field value has changed,

and it can then proceed to run any required application validation or business logic. Therefore, before the task guide can

determine that the step was completed by the user, it relies on the client to detect that the field value has changed.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/user-interface/media/taskguide3.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/user-interface/media/taskguide4.png


What can a task guide allow a user to do?What can a task guide allow a user to do?

The "On-rails" feature of task guidesThe "On-rails" feature of task guides

Error detectionError detection

The control is not visible on the formThe control is not visible on the form

When a user is completing a task guide, the client behaves in the same manner, with the same data, security, and

validation rules as it does when the user is not completing a task guide. There is no difference of behavior in the

client that would allow a user to take an action that they cannot otherwise take when they are not completing a

task guide. When a user is completing a task guide:

Any data the user enters is subject to the same data validation rules as when not playing the task guide.

Any data the user enters may be saved, and the user may modify data according to the same restrictions and

rules as when not playing the task guide.

Any security mechanisms the user encounters behave the same as when the user is not playing the task

guide.

Any forms or controls the user accesses are subject to the same security and access mechanisms as when the

user is not playing the task guide.

By default, when a user begins a task guide, they are placed "on-rails". These "rails" prevent the user from

clicking on elements other than the element the task guide is pointing to. When the user tries to click on

something outside of the UI element that the task guide is pointing to, the task guide pop-up will animate to let

the user know that they cannot progress until they complete the current step of the task guide.

While a user is prohibited from clicking on other elements, the user is not prevented from tabbing through the

other controls on the form, and the user is not prevented from using keyboard shortcuts. This is by design, as

the "on-rails" feature is designed for and targeted at first-time users, who are expected to primarily use the

mouse as they become familiar with the application.

More advanced or experienced users can turn off the "on-rails" feature when they complete a task guide. At any

point during the task guide, these users can turn off the rails by clicking the UnlockUnlock button that appears on the

Task recorder toolbar at the top of the page. This button can also be used to restore the rails at any point during

the task guide. In some situations, the task guide might automatically turn off the "on-rails" feature. When the

rails are turned off, the user can click UI elements just as they do when the task guide isn't running. The "on-

rails" feature might be automatically turned off in the following situations:

The user is being directed to go to a page by using the navigation pane or navigation search.

The task guide enters an error state (see the next section for a list of error states).

The task guide is showing an info step.

Because the user can use either entry point, the task guide doesn't point to a specific entry point, and

it doesn't prevent the user from using either entry point.

An error state occurs when the task guide is not able to point to the UI element that is associated with the

current step because the UI element is not visible on the screen. When the task guide detects that the current

step requires the user to interact with a UI element that is not visible, then the task guide pop-up will move to

the upper-right side of the screen. These causes of an error state can be simplified into two categories.

This error state usually occurs when the user has opened or closed the incorrect tab, FastTab, collapsible section,

FactBox, or pop-out menu.

Because the UI element that is needed for the current step is somewhere on the current form, but it is not visible

on the screen, the task guide pop-up will simply move to the upper-right side of the screen while displaying the

same instruction that informs the user of the action they need to take.

Because the task guide can't find the UI element on the screen, the user must manually determine what is

causing the UI element to be hidden and then make the element visible on the screen. The task guide pop-up

will automatically detect that the UI element is visible and will reposition itself so that it's pointing at the now-



The control is not on the formThe control is not on the form

Next step and Previous stepNext step and Previous step

The See more buttonThe See more button

Taking screenshots in Task recorder

visible element.

This error state usually occurs when the user has gone to the wrong form, either by navigating to the wrong

form or by leaving the correct form.

Because the UI element is not visible on the screen, the task guide pop-up will move to the upper-right side of

the screen. In addition, when the task guide detects the user is on the wrong form, the task guide pop-up text

will change to inform the user of the form they should navigate to.

In some cases, the task guide pop-up will not mention the form by name. This is because the user may need to

navigate to a dynamic form. A dynamic form is a form that is not modeled, frequently known as a runtime-

generated form. These sorts of forms do not have a proper name. Some examples of runtime-generated forms

include simple and custom lookups. The way for a user to navigate to a lookup form is to re-open the lookup.

The Next stepNext step and Previous stepPrevious step buttons appear in the task guide pop-up and let a user manually control the

flow of the task guide. When these buttons are clicked, the task guide will go to the next or previous step. The

task guide doesn't verify that the user has completed a step before it goes to the next or previous step.

The task guide nevernever  automatically completes any step for the user, even when the Next stepNext step and PreviousPrevious

stepstep buttons are used. Use of these buttons can cause an error state if the previous or next step refers to a UI

element that isn't on the current page. When the user is completing an info step, the only way to proceed is to

use the Next stepNext step button. This action is required because an info step doesn't represent an action that was

recorded on any UI element. Because no action was recorded in the task recording, the task guide doesn't have

the necessary information to determine what action it should expect the user to complete.

When the See moreSee more button is clicked, the task guide pop-up expands to show additional information that is

related to the step. The additional information is often optional reading material that isn't required for the user

to successfully complete the step. The following information might be included:

An ExampleExample value

A NoteNote

The Example value is the value that was originally used when the task recording was created.

Example values appear only for steps that use non-lookup fields. These fields include text fields,

number fields, date fields, combo boxes, and check boxes.

A Note may contain scenario-specific information that will help provide context to the user about the

current step of the task guide.

By using a pre-releasepre-release Chromium browser extension that works for both the new (Chromium-based)

Microsoft Edge browser and Google Chrome, Task recorder can take screenshots of the browser as a user

records a business process. After the user completes the recording, Task recorder can use these screenshots to

generate Microsoft Word documents. To turn on this functionality, follow these steps to install the pre-release

Chromium extension that enables Task recorder to take screenshots during recording.

1. Download the FMLabTaskRecorderScreenshotFMLabTaskRecorderScreenshot folder that contains the extension from GitHub, at

https://github.com/Microsoft/FMLab.

2. On-premises deployments only:On-premises deployments only: Adjust the manifest for the extension so that it matches the

following code. Replace <hostname> with the base URL for your environment.

https://github.com/Microsoft/FMLab


...
"content_scripts": [
    {
        "matches": ["https://*.dynamics.com/*", "<hostname>"],
        "js": ["screenshot.js"]
    }
    ...

...
"content_scripts": [
    {
        "matches": ["https://*.dynamics.cn/*"],
        "js": ["screenshot.js"]
    }
    ...

3. 21Vianet deployments only:21Vianet deployments only: Adjust the manifest for the extension so that it matches the following

code. Replace .com.com with .cn.cn

4. Open the latest Microsoft Edge browser or Google Chrome.

5. Select Settings and more > ExtensionsSettings and more > Extensions  in Microsoft Edge (or Customize and control GoogleCustomize and control Google

Chrome > More tools > ExtensionsChrome > More tools > Extensions  in Google Chrome).

6. Select Developer modeDeveloper mode.

7. Click Load unpacked extensionLoad unpacked extension.

8. Browse to the folder that contains the Task recorder extension by using the path FMLab-master >FMLab-master >

FMLab > TaskRecorderScreenshotFMLab > TaskRecorderScreenshot, and then select Select FolderSelect Folder .

9. Make sure that EnabledEnabled is selected so that extension is turned on.

10. Restart the browser.

Task recorder will now take screenshots of the tab where the client is running. These screenshots are available

for one week after the recording has been played. (If you're running a platform version that is earlier than



Generating tests from a recording

Import a recorded testImport a recorded test

Appendix
Controls that are known to have incomplete support for Task recorderControls that are known to have incomplete support for Task recorder

Platform update 16, the screenshots are available for only 15 minutes.) If the screenshots have expired, you can

regenerate them by playing the task recording again.

Note that Task recorder does notdoes not capture screenshots from other tabs or of the user's desktop.

After a business process recording has been completed by using Task recorder, a developer can import the raw

developer recording file (.xml file) into Visual Studio to create an X++ test. The import tool generates a human-

readable X++ test from the recording, and translates any control gestures, validations, or tasks into the

appropriate test code.

1. Open Visual Studio by using the Finance and Operations development tools.

2. Go to Dynamics 365 > Addins > Impor t task recordingDynamics 365 > Addins > Impor t task recording.

3. In the Impor t task recordingImpor t task recording menu, use the BrowseBrowse button to locate a previously downloaded

recording file.

4. Optionally, choose to have the generated test code be added to the startup project. This requires that a

solution containing a project is set as the startup project. This will place the generated X++ test into the

same model as the project.

5. If you're creating a new project, select the model for the project. The generated X++ test will be put in this

model. For the generated test to be successfully built, the model must have references to the

TestEssentialsTestEssentials  model.

6. Click Impor tImpor t.

7. In the New ProjectNew Project dialog box, provide a name for the project.

8. After the project is created, the user can open and inspect the generated code.

9. To run the test, build the project.

10. Go to Test > Windows >Test ExplorerTest > Windows >Test Explorer .

Table

Filter pane, which is the filter that pops out from the left side

Enhanced previews

When adding filters to the filter pane, the steps are delayed. The steps do not get recorded until the

user clicks "Apply" on the Filter pane.

No planned support for recording gestures inside of enhanced previews. While recording, enhanced

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/user-interface/media/importnewproject_taskrecorderguide.png


Controls that can be recorded, but have limited support for the Copy/Paste/Validate gesturesControls that can be recorded, but have limited support for the Copy/Paste/Validate gestures

Controls that are known to have incomplete support for being used in a task guideControls that are known to have incomplete support for being used in a task guide

NOTENOTE

No extensible controls are supported out of the box, except Segmented Entry.

previews will be disabled.

Extensible control owners need to individually build support for Task recorder.

Date/Time

Image

Filter pane

Message box

Doesn't support copy/pasting "Never" as a value.

No ability to copy/paste/validate an image value.

Copy/Paste works, but the UI will not show the pasted data. You can proceed as if it pasted correctly.

You cannot validate the text in the message box.

Quick Filter, which is the filter control that appears above lists

Filter pane, which is the filter that pops out from the left side

Does not support displaying a "generic value" during the task guide. Currently displays the value that

was used during recording.

The task guide does not point to the individual elements within the Filter pane that need to be clicked

on.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

Learn about Task recorder

Plan your task recording

This topic explains what Task recorder and task guides are, how to create task recordings, and how to customize

Microsoft task guides and include them in your Help.

You can record your own task guides for Dynamics 365 Human Resources, but you won't be able to save them to a

Business Process Modeler (BPM) library or open them from the Help pane at this time. You can save them locally or to a

network location, and then open and replay them using Task recorder.

Task recorder is a tool that you can use to record actions that you take in the product user interface (UI). When

you use Task recorder, all of the events that you perform in the UI that are executed against the server—

including adding values, changing settings, removing data—are captured. The steps that you record are

collectively called a task recording. Task recordings can be used in many ways:

Task recordings can be played as task guides.Task recordings can be played as task guides. Task guides are an integral piece of the Help

experience. A task guide is a controlled, guided, interactive experience through the steps of a business

process. The user is instructed to complete each step by way of a pop-up prompt (or "bubble"), which will

animate across the UI and point to the UI element that the user should interact with. The "bubble" also

provides information about how to interact with the element, such as “Click here” or “In this field, enter a

value.” A task guide runs against the user ’s current data set and the data that is entered is saved in the user ’s

environment.

Task recordings can be saved as Word documents.Task recordings can be saved as Word documents. This allows you to easily produce printable training

guides.

You can create your own task recordings, play task recordings provided by Microsoft, or modify Microsoft-

provided task recordings to reflect your configuration. For more information about Task recorder, see Task

recorder.

Whether you’re creating a new task recording or basing your recording on a Microsoft task recording, keep the

following information in mind.

Plan your recording like you would a video. Make all your decisions ahead of time.

Walk through the business process once or twice without recording it to understand the steps.

When you walk through the process before you record, notice where you use shortcut keys or the EnterEnter  key,

so that you can avoid using them during the actual recording.

Identify the following:

Do you want to group steps together into sub-tasks? Sub-tasks visually set apart sections of a process.

For example, if you are creating a recording for "Creating and releasing a product," you may want to

group together the steps that are required to create a product, and then group together the steps that

are required to release the product. Sub-tasks also make longer processes easier to read.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/user-interface/task-recorder-training-docs.md


Do you want to add annotations, and if so, where? See "Understand the different types of annotations"

below for more information.

What values will you add in the various fields as you complete the steps of the business process? It is

a good idea to know what you'll select or enter as you proceed so that you don't backtrack or fix

mistakes as you're recording.

Write your descr iption and annotations ahead of timeWrite your descr iption and annotations ahead of time

At the beginning of each task recording, there’s a description field that allows you to enter an introduction to

the recording. It is a good idea to write and save the description ahead of time in a separate document so you

can copy and paste it into the task recording when you are recording. That way, you can spend time refining

the text when you aren't in the process of recording. Cutting and pasting the text makes the recording

process go more quickly and smoothly.

For each step in a task recording, you can create annotations. During playback of a task guide, annotations

appear in the "bubble" as notes above or below the text for the step. When viewed as text in the Help pane,

annotations appear as text inline in the step. As with the description, it is a good idea to write and save your

annotations in a separate document. When you’re recording the task recording, cut and paste the

annotations in from that document.

Understand the different types of annotationsUnderstand the different types of annotations  All annotations are optional. Only add them when they’ll

provide helpful information to the user.

TitleTitle: A title annotation will appear before the step text that task recorder automatically generates. In the task

guide, the title annotation appears above the automatically generated text. Use this type of annotation to

explain why the user is doing the step or to give additional context.

This is the editing pane that you see when you add an annotation as you create your recording. Enter a title

annotation in the TitleTitle box.



This is what the title annotation looks like in the "bubble" in the task guide.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/user-interface/media/screen1.png


Notes:Notes: A notes annotation will appear after the step text that task recorder automatically generates. In the

task guide it will only be visible if the user clicks the Show moreShow more link in the task guide bubble. Use this type

of annotation to describe anything that a user needs to know to complete the step.

This is the editing pane that you see when you add an annotation as you create your recording. Enter a notes

annotation in the NotesNotes  box.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/user-interface/media/screen2.png


This is what the notes annotation looks like in the "bubble" in the task guide.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/user-interface/media/screen3.png


Info stepInfo step: These annotations are created by right clicking on a control or anywhere on a form < TaskTask

recorderrecorder  < Add info step.Add info step. Info steps appear as a numbered step at whatever point you insert it, even

though no action was recorded in the UI. You can add a form-level info step or an info step associated with a

control. When an info step is associated with a form, the task guide “bubble” will appear someplace on the

form, with no pointer, when the task guide is played. When an info step is associated with a control, the task

guide “bubble” will point to the control when the task guide is played. In the Help pane, an info step

annotation will appear as a numbered step with whatever text you entered. Use info steps to prepare the user

for the next steps, to describe steps that need to be done outside of the application, or to refer to other

recordings (although you cannot create hyperlinks in annotations).

Determine how long to make your recordingDetermine how long to make your recording

The user will generally either read or play the recording from start to finish, so don’t combine steps or tasks

that are better done separately.

Try not to record a long scenario that spans multiple sub-processes. For example, “Operate in-store customer

service desk” is too broad; break it up into shorter tasks such as “Accept returns” and “Add to gift card.”

If a task can be carried out as part of several different business processes, create a separate recording for it,

and you can refer to it in the other recordings.

If the process involves multiple tasks that the person likely does all at once, you can keep the tasks in one

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/user-interface/media/screen4.png


Create your task recording

Copy and customize Microsoft's task recordings

Additional resources

NOTENOTE

recording, for example, “Set up and assign functionality profiles.”

If it is something someone does once (such as configuration) and then another task that they can do

immediately afterward but may do repeatedly, and on its own, break them up into two task recordings.

Decide where, in the UI, to star t a recordingDecide where, in the UI, to star t a recording The page that you are on when you start recording a task

recording affects which page the task guide is displayed for. For example, if you want your task recording to be

listed in the Help pane when a user clicks Help on the General ledger parameters page, you must start your

recording on the General ledger parameters page. Save recordings as .axtr  filesSave recordings as .axtr  files  When you are done creating

or editing a task recording, you are presented with several options for how you want to download, or save the

recording. You can download the file as a task recording package (.axtr), download it as a raw recording file

(.xml), download it as a Word document, or save the file to an LCS library. It is a good idea to always save your

task recording as a task recording package file (.axtr). This will help make maintenance of the file easier if

procedures or annotations need to change later. If you want to download the file as a Word document, also save

it as a task recording package file.

For detailed walk-through steps, see Task recorder resources.

You can download and edit Microsoft's task recordings to use them for your own Help documentation or

training materials. To download a Microsoft task recording, follow these steps:

1. Open Task recorder. Task recorder is located in the SettingsSettings  menu.

2. In the Task recorder pane, click Maintain a recording.Maintain a recording.

3. Under Where is the recordingWhere is the recording, click It is in an LCS librar yIt is in an LCS librar y .

4. Click Select the LCS librar ySelect the LCS librar y .

5. Select the Microsoft global library.

6. In the tree, select the business process library node that the task recording is associated with.

7. Click OKOK.

8. Click Star tStar t.

9. At this point, step through the recording, changing any steps as you go to re-record it. NoteNote: If you only need

to change the text of a recording, you can open the recording in Edit a recording's annotationsEdit a recording's annotations  mode,

and then save it.

10. After the recording has played to the end, click StopStop in the task recorder bar at the top of the screen.

11. Choose how you want to save the task recording.

Help system

Connect the Help system

Task Recorder

Create Rich Help Topics with Task Recorder (external link)

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://mbspartner.microsoft.com/AX/Videos/970
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Videos for Finance and Operations development and administration
Data integrationData integration

Data managementData management

DevelopmentDevelopment

IntelligenceIntelligence

Lifecycle Services (LCS)Lifecycle Services (LCS)

On the Microsoft Dynamics 365 YouTube channel, you can find videos created by Microsoft that demonstrate a

wide range of business solutions for Dynamics 365 products. This section lists the "how-to" videos for Finance

and Operations apps that are hosted on the channel.

Some of the videos listed were published under a previous product name, but are still applicable.

Prospect to cash integration

Synchronize a work order between Dynamics 365 for Field Service and Finance and Operations apps

Use data entities and data packages

How to resolve conflicts in Visual Studio

Optimization advisor

Setting up a development branch and build

Setting up a development machine

Azure DevOps integration with Lifecycle Services

How to edit an embedded report in an analytical workspace

How to embed PowerBI.com reports in Finance and Operations apps

Bring your own database (BYOD) to Finance and Operations apps

How to use cost management Power BI content in Dynamics 365

Asset library in Lifecycle Services

Cloud-hosted environments

Creating support tickets from Dynamics 365 for Operations

Deploying environments

Getting started with Lifecycle Services

Deploying code to a sandbox environment

Deploying code to a production environment

Implementation projects in Lifecycle Services

Manage the code upgrade and tool process

Managing business process libraries in Lifecycle Services

Methodologies in Lifecycle Services

Request a production environment

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/videos.md
https://www.youtube.com/channel/UCJGCg4rB3QSs8y_1FquelBQ
https://youtu.be/AVV9x5x-XCg
https://www.youtube.com/watch?v=46ylO7raZAo&feature=youtu.be
https://www.youtube.com/watch?v=UCyzbA41j8g&feature=youtu.be
https://youtu.be/4rxO0zUN2zU
https://www.youtube.com/watch?v=MRsAzgFCUSQ&t=4s
https://www.youtube.com/watch?v=qXLd-NMx9OY
https://www.youtube.com/watch?v=cqp9MetfiyM
https://www.youtube.com/watch?v=0QyyyUp1zHQ&t=1s
https://youtu.be/_8WlwmSggcQ
https://youtu.be/gGWuNJDoi-M
https://www.youtube.com/watch?v=-MaxtBJu2_o&feature=youtu.be
https://www.youtube.com/watch?v=5jWHnM_C7WM&feature=youtu.be
https://www.youtube.com/watch?v=z-2xMRa1nOs
https://www.youtube.com/watch?v=igjVt1lbyLQ&t=17s
https://www.youtube.com/watch?v=avENUYBTBlA&t=2s
https://www.youtube.com/watch?v=FUROjGuhQEA&t=68s
https://www.youtube.com/watch?v=qLBjKAPaqN4&t=24s
https://www.youtube.com/watch?v=5azLeOO078k
https://www.youtube.com/watch?v=ogXo-saZkmE&t=2s
https://www.youtube.com/watch?v=V1vVOgcTuw4&t=18s
https://www.youtube.com/watch?v=M-AtR6ocYM8&feature=youtu.be
https://www.youtube.com/watch?v=S5msxj-2-x0
https://www.youtube.com/watch?v=YRMJ15DvgZ8
https://www.youtube.com/watch?v=5j1GapLr3MY&feature=youtu.be


Regression suite automation tool (RSAT)Regression suite automation tool (RSAT)

Videos for Dynamics 365 Finance
Customize the appCustomize the app

Financial reportingFinancial reporting

Help systemHelp system

Office integrationOffice integration

Organization administrationOrganization administration

Revenue recognitionRevenue recognition

Tax engineTax engine

Videos for Dynamics 365 Supply Chain Management
CostsCosts

Customer portalCustomer portal

Help systemHelp system

Master planningMaster planning

Office integrationOffice integration

Refreshing data in a production environment

Uptake a new platform release after Platform update 3

Use telemetry to monitor key performance counters in Dynamics Lifecycle Services

How to use task recorder to create a test case for the Regression suite automation tool (RSAT)

How to create a test plan in Azure DevOps to use with the Regression suite automation tool (RSAT)

How to use the Regression suite automation tool (RSAT)

The improved Excel experience in Regression Suite Automation Tool (RSAT) 2.0

Add custom fields

Embed Power Apps

Find the version of Report designer

How to contribute to the Microsoft Dynamics 365 documentation

Create an Excel template for header and line patterns

Document management

How to use revenue recognition

Tax engine overview

Cost control mobile workspace

Get started with Cost accounting

Use Excel for cost analysis

Overview of the Customer portal template

Invite customers to register and use your customer portal

How to contribute to the Microsoft Dynamics 365 documentation

Master planning setup wizard

Create an Excel template for header and line patterns

https://www.youtube.com/watch?v=VCd5SgkYPTw
https://www.youtube.com/watch?v=nkiKP2Au6OQ&feature=youtu.be
https://www.youtube.com/watch?v=18u6SC8GeFY&feature=youtu.be
https://youtu.be/bBr4BXAxTNI
https://youtu.be/3jIuBleAnQk
https://youtu.be/uhN9JItzGAk
https://youtu.be/fcEkSIVQ1Bg
https://www.youtube.com/watch?v=gWSGZI9Vtnc
https://www.youtube.com/watch?v=x3qyA1bH-NY
https://www.youtube.com/embed/icfA5Q3kp4w
https://youtu.be/m5djioozRbg
https://www.youtube.com/watch?v=RTicLb-6dbI&feature=youtu.be
https://www.youtube.com/watch?v=p4rl1CkiLN4&feature=youtu.be
https://youtu.be/v3amIsiqvoo
https://www.youtube.com/watch?v=jAFpEBOtNWI&feature=youtu.be
https://youtu.be/imsuTg8rUVk
https://youtu.be/1pUDtJQZ8FU
https://youtu.be/-HKHYdClvx8
https://youtu.be/nPrqoLuHfV8
https://youtu.be/drGUYHX9QIQ
https://youtu.be/m5djioozRbg
https://youtu.be/c-e6n-8rZb4
https://www.youtube.com/watch?v=RTicLb-6dbI&feature=youtu.be


Organization administrationOrganization administration

Procurement and sourcingProcurement and sourcing

Product information managementProduct information management

Production controlProduction control

Warehouse managementWarehouse management

FastTrack Tech Talks

NOTENOTE

Document management

Approve purchase orders on a mobile device

Onboard a new vendor

Change management capabilities

Batch balancing

Enhancements to the production order release process

Visual scheduling with Gantt chart for production and batch orders

Release production picking to the warehouse in batch

Use warehouse template to copy configuration

FastTrack Tech Talks focus on providing technical depth and best practices that provide customers and partners

with detailed knowledge that's specific to the subject areas.
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AA
a c c o u n t i n g  j o u rn a la c c o u n t i n g  j o u rn a l

a c c o u n t i n g  ru l ea c c o u n t i n g  ru l e

A C H ( A u t o ma t e d  C l e a r i n g  Ho u s e )A C H ( A u t o ma t e d  C l e a r i n g  Ho u s e )

a c t u a l  q u a n t i t ya c t u a l  q u a n t i t y

a d d re s s  v e r i f i c a t i o na d d re s s  v e r i f i c a t i o n

a g i n ga g i n g

a g i n g  p e r i o da g i n g  p e r i o d

BB
b a l a n c e  s h e e tb a l a n c e  s h e e t

b a l a n c e  s h e e t  a c c o u n tb a l a n c e  s h e e t  a c c o u n t

b a n k  re c o n c i l i a t i o nb a n k  re c o n c i l i a t i o n

b a t c h  a t t r i b u t eb a t c h  a t t r i b u t e

b e s t -b e f o re  d a t eb e s t -b e f o re  d a t e

b e s t -b e f o re  p e r i o db e s t -b e f o re  p e r i o d

b i l l  o f  e x c h a n g eb i l l  o f  e x c h a n g e

b l o c k i n gb l o c k i n g

B O M  ( b i l l  o f  ma t e r i a l s )B O M  ( b i l l  o f  ma t e r i a l s )

b u d g e t  c o n t ro lb u d g e t  c o n t ro l

This glossary defines key terms and concepts in Finance and Operations apps.

A journal that is used to record the financial consequences of accounting events in an accounting system.

A rule in an accounting system that controls the principles, methods, and procedures for classifying, recording,

and reporting the financial consequences of accounting events.

An electronic funds transfer system available in the United States that facilitates the transfer of funds between

receiving party and originating party bank accounts.

The measured quantity that is input into or output from an activity.

The service that is provided by a credit card processor that validates that the billing address provided by a card

holder matches the information on file with the issuing bank.

The process of classifying time periods by age.

The number of days in a time period used to report an overdue customer payment balance.

A statement of the financial position of an organization that reports the state of assets, liabilities, and equity on a

specified date.

An account that describes the changes in value reported on a balance sheet.

A practice of reconciling a ledger account that represents a bank account by matching ledger account entries to

bank statement entries.

A product attribute of a process batch or a transfer batch.

A recommended date for obtaining the optimum quality or characteristic of a product.

The time period in which to obtain the optimum quality or characteristic of a product.

A source document that documents an unconditional request for a third-party to pay a second party on

demand.

The action of placing a document or product on hold.

A list of products and their quantities that are required to produce one product.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/glossary.md


b u d g e t  c o n t ro l  d i me n s i o nb u d g e t  c o n t ro l  d i me n s i o n

b u d g e t  c o n t ro l  ru l eb u d g e t  c o n t ro l  ru l e

b u d g e t  c y c l e  t i me  s p a nb u d g e t  c y c l e  t i me  s p a n

b u d g e t  g ro u pb u d g e t  g ro u p

b u d g e t  mo d e lb u d g e t  mo d e l

b u l k  i t e mb u l k  i t e m

b u n d l eb u n d l e

b u s i n e s s  u n i tb u s i n e s s  u n i t

CC
c a p a c i t y  l o a dc a p a c i t y  l o a d

c a p a c i t y  p l a n n i n gc a p a c i t y  p l a n n i n g

c a r ry -f o rw a rd  b u d g e tc a r ry -f o rw a rd  b u d g e t

c a s h -g e n e ra t i n g  u n i tc a s h -g e n e ra t i n g  u n i t

c a t c h  w e i g h tc a t c h  w e i g h t

c h a r t  o f  a c c o u n t sc h a r t  o f  a c c o u n t s

C O G S ( c o s t  o f  g o o d s  s o l d )C O G S ( c o s t  o f  g o o d s  s o l d )

c o n t ra c t o rc o n t ra c t o r

c o -p ro d u c tc o -p ro d u c t

c o s t  c e n t e rc o s t  c e n t e r

c o s t  v a r i a n c ec o s t  v a r i a n c e

c o s t i n gc o s t i n g

A practice of authorizing expenditure only when budget funds can be reserved to meet future payment

commitments.

A combination of active financial dimensions values used to allocate budget funds to pay for planned activities.

The encoding of a business decision to check committed and actual expenditure against available budget funds

allocated for detailed or aggregate activities defined by valid budget control dimension value combinations.

A time period specified as a number of fiscal calendar periods. The budget period can be different from the

accounting period.

A set of financial dimension values in a budget dimension hierarchy that is used to calculate aggregate budget

funds allocated to superordinate financial dimension values by summing budget funds allocated to subordinate

financial dimension values.

A planning structure used to schedule budget fund allocations and expenditures.

A formula item input into a product delivery activity.

The combination of a number of products for sale as one unit.

A semi-autonomous operating unit that is created to meet strategic business objectives.

The maximum amount of scheduled work that a work center can perform at a required capacity level.

A procedure for determining the resource capacity requirements that meet the demand of future output during

specific time periods.

The budget that is transferred from one fiscal year to the next and that is reserved for open purchase orders in

the new fiscal year.

The smallest group of classifiable assets that generates cash independently of other assets within an

organization. These groups of assets are used to measure impairment losses that will be incurred.

The actual or nominal weight of a sales item or inventory item.

A list of main accounts.

An accounting category used to sum the financial consequences of manufacturing products and carrying

inventory.

A role assumed by a person who participates in a contractor-employer relationship with a legal entity.

An item produced jointly with another item.

An operating unit whose managers are accountable for budgeted and actual expenditures.

The difference between an expected cost and an actual cost.



C TP  ( c a p a b l e -t o -p ro mi s e )C TP  ( c a p a b l e -t o -p ro mi s e )

c u r re n c y  c o d ec u r re n c y  c o d e

c y c l e  t i mec y c l e  t i me

DD
d a s h b o a rdd a s h b o a rd

d a t a  e n t i t yd a t a  e n t i t y

d e l e g a t ed e l e g a t e

d e l i v e ry  n o t ed e l i v e ry  n o t e

d e ma n d  f o re c a s td e ma n d  f o re c a s t

d e ma n d  f o re c a s t i n gd e ma n d  f o re c a s t i n g

d e p l o y a b l e  p a c k a g ed e p l o y a b l e  p a c k a g e

d e s i g n e rd e s i g n e r

d i me n s i o n -b a s e d  p ro d u c t  c o n f i g u ra t i o nd i me n s i o n -b a s e d  p ro d u c t  c o n f i g u ra t i o n

d i s t i n c t  p ro d u c td i s t i n c t  p ro d u c t

d o c u me n t  ma n a g e me n t  s y s t e md o c u me n t  ma n a g e me n t  s y s t e m

d u t yd u t y

EE
E F T ( e l e c t ro n i c  f u n d s  t ra n s f e r )E F T ( e l e c t ro n i c  f u n d s  t ra n s f e r )

e v e n te v e n t

E P E  ( Ev e ry  P ro d u c t  Ev e ry )E P E  ( Ev e ry  P ro d u c t  Ev e ry )

e x t e n s i o ne x t e n s i o n

The process of calculating, assigning, and allocating the cost of economic resources acquired, produced, or

delivered by an organization.

The portion of product output from available operations resources and available input product required to fulfill

a specific customer requirement.

An alphanumeric identifier that represents a currency unit.

The time taken to complete an activity.

The typical start page in Finance and Operations apps. On the dashboard, users see a section for each

workspace that they have access to. Each section displays the tiles from the summary sections in the related

workspace. The dashboard consists of a name and sections with tiles.

An information structure that represents the data characteristic of an entity.

A delegate is a type that represents references to methods with a particular parameter list and return type.

A business document that documents the delivery of products between two parties.

A prediction of future product demand.

A business process that estimates future demand and creates demand forecasts based on historical transaction

data.

The vehicle used for deployment on User Acceptance Test (UAT) and production environments.

A Visual Studio tool that you used to create, update, and inspect your model elements.

A configuration technology used to create product variants by selecting values for product dimensions.

A uniquely identifiable product.

An application service for storing and handling an organization's documents.

In the security model, a set of application access privileges that are required for a user to carry out their

responsibilities.

A networked system for transferring funds from one bank account to another.

An event lets a class or object to notify other classes or objects when something of interest occurs.

A lean concept that is used to establish a regular repeating production cycle.

Customizing an application by adding functionality to existing code.



FF
f i n a n c i a l  d i me n s i o nf i n a n c i a l  d i me n s i o n

f i n a n c i a l  d i me n s i o n  v a l u ef i n a n c i a l  d i me n s i o n  v a l u e

f i n a n c i a l  s t a t e me n tf i n a n c i a l  s t a t e me n t

f i x e d  c o s tf i x e d  c o s t

f i x e d  c u r re n c yf i x e d  c u r re n c y

f i x e d  q u a n t i t y  k a n b a nf i x e d  q u a n t i t y  k a n b a n

f o rmu l af o rmu l a

f o rmu l a  i t e mf o rmu l a  i t e m

GG
g e n e ra l  b u d g e t  re s e rv a t i o ng e n e ra l  b u d g e t  re s e rv a t i o n

g ra c e  p e r i o dg ra c e  p e r i o d

G ST ( g o o d s  a n d  s e rv i c e s  t a x )G ST ( g o o d s  a n d  s e rv i c e s  t a x )

II
i n t e rc o mp a n yi n t e rc o mp a n y

i n v o i c e  ma t c h i n gi n v o i c e  ma t c h i n g

i t e m a l l o c a t i o n  k e yi t e m a l l o c a t i o n  k e y

i t e m re l a t i o ni t e m re l a t i o n

KK
k a n b a nk a n b a n

k a n b a n  f l o wk a n b a n  f l o w

k a n b a n  j o bk a n b a n  j o b

k a n b a n  j o b  c o n s u mp t i o nk a n b a n  j o b  c o n s u mp t i o n

k a n b a n  ru l ek a n b a n  ru l e

A financial data classifier created from the parties, locations, products, and activities in an organization and used

for management reporting.

A data element in the domain of a financial dimension.

A report that documents the financial information and financial position of an organization.

A cost that does not vary with changes in product delivery throughput or output.

A currency that has a fixed exchange rate in relation to another currency.

A type of kanban that is used when the number of kanbans that are assigned to a kanban rule is constant.

A numeric relationship among production process inputs and production process outputs.

An output of a batch process controlled by a formula.

A document that is often used by public sector entities to set aside or earmark budgeted funds so that those

funds are not available for other purposes.

The time period beyond a specified date during which an obligation can be fulfilled without penalty.

A value-added tax levied in some countries/regions.

Occurring between or relating two or more legal entities that are part the same organization that consolidates

the accounts of all legal entities.

A practice of matching vendor invoice prices and product quantities to purchase orders and product receipts.

A product family grouping that is used for forecast and demand scheduling.

A reference to the item allocation group or the item and its product dimensions in a kanban rule.

A signal that communicates a requirement for a quantity of product.

Defines the sequence of activities that are performed for kanbans that are created for a kanban rule.

A process or transfer activity in a production flow that is triggered by a Kanban.

The withdrawal of product components from inventory in order to complete the kanban production jobs.

A rule in a lean manufacturing system that realizes material planning and replenishment policies by controlling



LL
l e a n  ma n u f a c t u r i n gl e a n  ma n u f a c t u r i n g

l e a n  s c h e d u l e  g ro u pl e a n  s c h e d u l e  g ro u p

l e d g e r  a c c o u n tl e d g e r  a c c o u n t

l i c e n s e  c o d el i c e n s e  c o d e

l i q u i d i t yl i q u i d i t y

MM
ma s t e r  s c h e d u l i n gma s t e r  s c h e d u l i n g

mo d e lmo d e l

mo d e l  e l e me n tmo d e l  e l e me n t

NN
N B V  ( n e t  b o o k  v a l u e )N B V  ( n e t  b o o k  v a l u e )

OO
o b j e c t  p e rmi s s i o no b j e c t  p e rmi s s i o n

o p e ra t i n g  u n i to p e ra t i n g  u n i t

o u t p u t  p ro d u c to u t p u t  p ro d u c t

o v e r l a y e r i n go v e r l a y e r i n g

PP
p a c k a g ep a c k a g e

p a r t yp a r t y

p e g g i n gp e g g i n g

how process and transfer activities are coordinated in production flows.

A philosophy in which manufacturing operations promote lean production flows and business activities.

A way in which to aggregate items for production, for example, based on a setup group, shipping group, or

transport group.

A classifier created from the combination of main account value and other financial dimension values listed in a

chart of accounts and used to classify the financial consequences of economic activity.

An alphanumeric key that grants a party the right to use software or software components as prescribed in the

terms of the license agreement, and that activates and inactivates software modules, software capabilities, and

software functions.

The ability of a party to use current assets to settle current liabilities.

The process for generating a timetable for matching supply with demand.

A model contains code elements and reference metadata. It is created and inspected in Visual Studio.

A model is a group of elements (source files and metadata) that constitutes a distributable software solution.

The model is a design-time concept.

The value of a fixed asset calculated as the difference between the original cost of the fixed asset minus its

accumulated depreciations.

A permitted create, read, update, delete, or execute operation on a securable object.

An organization that divides the control of economic resources and operational processes among people who

have a duty to maximize the use of scarce resources, to improve processes, and to account for their

performance.

The physical products that result from an activity.

A method of customizing source code by providing new source code that overrides the default source code.

A package is a compilable and deployable unit of one or more models.

A person or organization that participates in economic activities.



p e g g i n g  e v e n tp e g g i n g  e v e n t

p l a n n e d  i n t e rc o mp a n y  d e ma n dp l a n n e d  i n t e rc o mp a n y  d e ma n d

p o s tp o s t

p re p a re rp re p a re r

p ro c u re me n t  c a t a l o gp ro c u re me n t  c a t a l o g

p ro d u c t  d i me n s i o np ro d u c t  d i me n s i o n

p ro d u c t  f a mi l yp ro d u c t  f a mi l y

p ro d u c t  ma s t e rp ro d u c t  ma s t e r

p ro d u c t  re c e i p tp ro d u c t  re c e i p t

p ro d u c t  v a r i a n tp ro d u c t  v a r i a n t

p ro d u c t i o n  f l o wp ro d u c t i o n  f l o w

p ro d u c t i o n  f l o w  mo d e lp ro d u c t i o n  f l o w  mo d e l

p ro d u c t i o n  o rd e rp ro d u c t i o n  o rd e r

p ro d u c t i o n  s c h e d u l ep ro d u c t i o n  s c h e d u l e

p ro s p e c tp ro s p e c t

p u rc h a s e  a g re e me n t  p o l i c yp u rc h a s e  a g re e me n t  p o l i c y

p u rc h a s e  o rd e r  p o l i c yp u rc h a s e  o rd e r  p o l i c y

p u rc h a s e  q u o t a t i o np u rc h a s e  q u o t a t i o n

p u rc h a s e  re q u i s i t i o np u rc h a s e  re q u i s i t i o n

QQ

The process of tracing the quantity of a required item to its source.

A resource flow event that signals the demand for a product.

Predicted demand for a product by a legal entity that assumes the role of a vendor. The planned demand is

generated from planned demand for the product from a downstream legal entity.

To record the monetary value of an economic event in a specific account, or to summarize and reclassify general

and subsidiary journal account entries into general and subsidiary ledger account entries.

The person who creates a source document to initiate a request for economic resources.

A listing of product offerings that are grouped by procurement category. A procurement catalog is used to

request products for internal use by an organization.

The size, color, or configuration product attributes that are used for dimension-based product configuration.

A unique grouping of items, services, or rights that either participates in the same production or delivery

activities or that are offered to the same market segments. The grouping is represented by using a forecast

allocation key.

A standard or functional product representation that is the basis for configuring product variants.

A source document that documents the receipt of products ordered, the receipt of products returned, or the

receipt of products received on consignment.

A configuration of a product master.

A production process designed using Lean principles.

A representation of the production capacity provided by a group of work cells in a production flow process.

A source document that documents the requirements for producing items to meet a demand.

A schedule to produce a specific item and item quantity at a specific time and by specific human and operational

resources.

A participant that has the existing and potential ability to provide a service or probable future economic benefit

to a legal entity.

A policy that authorizes parties to modify purchase agreement terms.

A policy that authorizes parties to modify purchase order terms and to control order processing.

A source document that documents an offer to purchase a quantity of product for a specified price and by a

specified date in response to a request for quotation in a procurement process.

A source document that documents product requests so that they can be submitted for review and be used to

authorize purchasing by a purchasing organization.



q u a n t i t y  v a r i a n c eq u a n t i t y  v a r i a n c e

RR
re c e i p t  a d v i c ere c e i p t  a d v i c e

re c o n c i l i a t i o nre c o n c i l i a t i o n

re d u c t i o n  k e yre d u c t i o n  k e y

re g i s t e rre g i s t e r

R F Q  ( re q u e s t  f o r  q u o t a t i o n )R F Q  ( re q u e s t  f o r  q u o t a t i o n )

re q u e s t e rre q u e s t e r

SS
s a l e s  a g re e me n ts a l e s  a g re e me n t

s a l e s  a g re e me n t  p o l i c ys a l e s  a g re e me n t  p o l i c y

s a l e s  o rd e r  p o l i c ys a l e s  o rd e r  p o l i c y

s a l e s  q u o t a t i o ns a l e s  q u o t a t i o n

s e c u r i t y  ro l es e c u r i t y  ro l e

s e g re g a t i o n  o f  d u t i e ss e g re g a t i o n  o f  d u t i e s

s e q u e n c i n gs e q u e n c i n g

s h a re d  a s s e ts h a re d  a s s e t

s i n g l e  u s e  k a n b a ns i n g l e  u s e  k a n b a n

The difference between an ordered product quantity and a received product quantity when no more receipts are

expected.

A business document that documents a summary of the products a buyer receives from a vendor.

A practice of adjusting two or more accounts or statements so that the figures agree.

A method that is used to increase or decrease forecast requirements in master planning, based on user defined

percentages that are applied during specific periods.

A record that is used to record the operational, legal, and financial consequences of resource flow events in an

accounting system.

A source document that documents an invitation to bid on supplying a quantity of product for a specified price

and by a specified date.

The person who requests the economic resources.

A source document that documents an agreement between two or more parties based on an understanding that

a selling party will commit to selling a specific quantity or value of product over a period of time in exchange for

favorable prices and discounts.

A policy that authorizes parties to modify sales agreement terms.

A policy that authorizes parties to modify sales order terms and to control order processing and payment

processes.

A source document that documents an offer to supply a quantity of product for a specified price and by a

specified date in response to a request for quotation in a sales process.

A defined set of application access privileges. The security role assigned to a user determines which tasks the

user can perform and which parts of the user interface the user can view. All users must be assigned at least one

security role in order to access the system.

A design principle used to reduce the risk of fraud, irregularities, and errors that separates the recording,

verification, authorization, custody of assets, and periodic review duties of people who participate in, document,

or record the financial consequences of economic transactions.

The order in which jobs are processed or operations are performed at a manufacturing facility to achieve

objectives.

An asset that is used by more than one cash-generating unit (CGU). An example is a distribution center that is

used to store items before they are transported to different markets that share that same distribution center.

A type of kanban that is used with a fixed quantity kanban rule to meet exceptionally high demand. A single use

kanban does not trigger a new kanban when it is discarded.



s ma r t  ro u n d i n gs ma r t  ro u n d i n g

s o u rc e  re q u i re me n ts o u rc e  re q u i re me n t

s t a t i s t i c a l  b a s e l i n e  f o re c a s ts t a t i s t i c a l  b a s e l i n e  f o re c a s t

TT
t a k t  t i met a k t  t i me

Ta s k  g u i d eTa s k  g u i d e

Ta s k  re c o rd e rTa s k  re c o rd e r

Ta s k  re c o rd i n gTa s k  re c o rd i n g

t h re e -w a y  ma t c h i n g  p o l i c yt h re e -w a y  ma t c h i n g  p o l i c y

t ra n s f e r  b a t c ht ra n s f e r  b a t c h

t w o -w a y  ma t c h i n g  p o l i c yt w o -w a y  ma t c h i n g  p o l i c y

VV
v a l u e  s t re a mv a l u e  s t re a m

v a r i a n t  c o n f i g u ra t i o n  t e c h n o l o g yv a r i a n t  c o n f i g u ra t i o n  t e c h n o l o g y

V A T ( v a l u e -a d d e d  t a x )V A T ( v a l u e -a d d e d  t a x )

v e n d o r  c a t a l o gv e n d o r  c a t a l o g

v e n d o r  i n v o i c ev e n d o r  i n v o i c e

WW
w o rk  c e l lw o rk  c e l l

w o rk e rw o rk e r

w o rk s p a c ew o rk s p a c e

A marketing practice to use odd numbers that are marginally less than their nearest round number to set prices.

The product quantity documented on a source document line that creates a pegging requirement.

An estimate of future demand that is created by applying a forecasting algorithm to historical transaction data.

The time that it takes to produce one unit of a product.

A controlled, guided experience through the steps in a Task recording. A Task guide leads the user through the

experience that was recorded. All security, data, and application behaviors are the same when completing a Task

guide as they are without the Task guide. The Task guide uses the same instrumentation as Task recorder to

know when a user has completed the intended step, so that it can prompt the user to take the next step in the

recording.

A tool that is pre-installed in Finance and Operations apps. When recording, it records all events that the user

enters in the user interface that get executed against the server—including values added, settings changed, data

removed, etc.

A file that contains the actions and annotations that are captured when Task recorder is run.

A matching policy that requires one or more vendor invoice prices to match with one or more purchase order

prices and that requires one or more vendor invoice quantities to match with one or more product receipt

quantities.

The quantity of one or more items that is transferred or that can be transferred.

A matching policy that requires one or more vendor invoice prices to match with one or more purchase order

prices.

An operating unit that controls one or more production flows.

A method of modeling product masters and searching for product variant configurations.

A tax on products at each stage of their production based on the value added during that stage.

A listing of product offerings that are available for purchase from a vendor.

A source document that documents a vendor payment request. A vendor invoice can refer to one or more

purchase orders. When the vendor invoice is authorized, a payment can be made to the vendor.

A resource group that participates in a production flow activity.

A person who assumes the role of an employee or a contractor and is paid in exchange for services.



NOTENOTE

A page that provides an overview of one of the activities that the user performs. The page uses tiles, lists, and

charts to display pending work and related data from multiple sources, and the page surfaces frequent tasks

related to this data. Tiles shown in the summary section of the workspace are also displayed in the related

section in the dashboard.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Learning catalog for Dynamics 365 Supply Chain
Management
2/18/2021 • 2 minutes to read • Edit Online

Business and Technical Decision MakersBusiness and Technical Decision Makers

Business usersBusiness users

Implementation Project ManagersImplementation Project Managers

AdministratorsAdministrators

Find the right online training, in person workshops, and events for your role as a user of the Dynamics 365

Supply Chain application.

Do you decide whether to invest in new technologies?

Business and Technical Decision Makers Learning Catalog

Get started

Exam

Did you just get a new application to use?

Business Users Learning Catalog

Get Started

Core platform knowledge

Supply chain management

Manufacturing

Exam

Are you in charge of making sure your company’s implementation goes smoothly?

Implementation Project Manager Learning Catalog

Get started

Core platform knowledge

Supply chain management

Manufacturing

Exams

Do you need to keep systems and data flowing, provisioned, and secure round-the-clock?

Administrators Learning Catalog

Get started

Core platform knowledge

Core development

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/get-started/learning-catalog.md


DevelopersDevelopers

Functional consultantsFunctional consultants

Partner Sales and MarketingPartner Sales and Marketing

Solution architectsSolution architects

Migration and upgrade

Servicing

Testing

Exam

Do you need to write code to integrate with other data sources, extend core system functionality, or build a

complex application?

Developer Learning Catalog

Get started

Core development concepts

Servicing

Migration and upgrade

Testing

Exam

Are you an implementation expert for a business domain?

Functional Application Consultant Learning Catalog

Get started

Core platform knowledge

Manufacturing

Supply chain management

Exams

Are you responsible for helping your customers buy the right solution?

Microsoft Partner Sales and Marketing Learning Catalog

Get started

Exam

Do you design solutions that meet your customers' needs and budgets?

Solution Architects Learning Catalog

Get started

Core platform knowledge

Core development concepts

Migration and upgrade

Servicing



NOTENOTE

Testing

Exam

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


  

Learning catalog for business decision makers
considering Dynamics 365 Supply Chain
Management
2/18/2021 • 2 minutes to read • Edit Online

Get started

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

Learn the business value of
Microsoft Dynamics 365
and the Power Platform

Are you interested in
learning about business
applications? Perhaps you
don’t know where to begin
with Microsoft Dynamics
365 and Power Platform
applications? Learn how the
power of business
applications can help
transform your business.

Free, self-paced online
learning path

7 hours

Dynamics 365 and Power
Platform Fundamentals

Are you interested in
learning about business
applications? Start with this
learning path to see how
Dynamics 365 apps are
used. Learn about cloud
concepts, Power Platform,
and how to get started with
Dynamics 365 apps.

Free, self-paced online
learning path

5.5 hours

Get started with Finance
and Operations apps

Learn how Finance and
Operations apps support
businesses to manage their
global financial systems,
operational business
processes, and streamlined
supply chains to empower
people to make fast,
informed decisions. As the
first step in your career of
working with Finance and
Operations apps, you must
familiarize yourself with its
features and functionality,
whatever your desired role.

Free, self-paced online
learning path

2 hours

Do you decide whether to invest in new technologies?

The following catalog is organized from core knowledge to specific domains, and from most basic to most

advanced. If content exists in multiple formats, we'll let you know, so that you can choose the training format

that best meets your needs.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/get-started/learning-catalog-bdm.md
https://docs.microsoft.com/en-us/learn/paths/learn-business-value-of-dynamics-365-and-power-platform/
https://docs.microsoft.com/en-us/learn/paths/dyn-power-plat-bus-app-fundamentals/
https://docs.microsoft.com/en-us/learn/paths/get-started-finance-operations/


  

Course MB-900T01-A:
Dynamics 365
fundamentals

This course will familiarize
the learner with Dynamics
365 functionality and
business value. The course
will cover Dynamics 365
applications, the Power
Platform, cloud concepts,
the security model, and
licensing considerations.

Instructor-led in person or
online training, cost varies
by region and partner

1 day

Get started with Asset
Management for Dynamics
365 Supply Chain
Management

Asset Management is a
module for managing
assets and maintenance
jobs in Dynamics 365
Supply Chain Management.
Asset Management enables
you to efficiently manage
and carry out tasks related
to managing and servicing
many types of equipment in
your company, for example,
machines, production
equipment, and vehicles.
Asset Management
supports solutions across
numerous industries.

Free, self-paced online
learning module

1 hour

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

Exam

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT

Dynamics 365 Fundamentals Prove that you understand Microsoft
Dynamics 365, the Power Platform,
cloud concepts, licensing options, and
deployment and release options.

Exam, cost varies by region

NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://www.microsoft.com/learning/course.aspx?cid=MB-900T01
https://docs.microsoft.com/en-us/learn/modules/get-started-asset-management/index
https://docs.microsoft.com/en-us/learn/certifications/d365-fundamentals?wt.mc_id=learningredirect_certs-web-wwl
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


  

Learning catalog for users of Dynamics 365 Supply
Chain Management
2/18/2021 • 6 minutes to read • Edit Online

Get started

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

Learn the business value of
Microsoft Dynamics 365
and the Power Platform

Are you interested in
learning about business
applications? Perhaps you
don’t know where to begin
with Microsoft Dynamics
365 and Power Platform
applications? Learn how the
power of business
applications can help
transform your business.

Free, self-paced online
learning path

8 hours

Dynamics 365 and Power
Platform Fundamentals

Are you interested in
learning about business
applications? Start with this
learning path to see how
Dynamics 365 apps are
used. Learn about cloud
concepts, Power Platform,
and how to get started with
Dynamics 365 apps.

Free, self-paced online
learning path

5.5 hours

Get started with Finance
and Operations apps

Learn how Finance and
Operations apps support
businesses to manage their
global financial systems,
operational business
processes, and streamlined
supply chains to empower
people to make fast,
informed decisions. As the
first step in your career of
working with Finance and
Operations apps, you must
familiarize yourself with its
features and functionality,
whatever your desired role.

Free, self-paced online
learning path

2 hours

Did you just get a new application to use?

The following catalog is organized from core knowledge to specific domains, and from most basic to most

advanced. If content exists in multiple formats, we'll let you know, so that you can choose the training format

that best meets your needs.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/get-started/learning-catalog-business-user.md
https://docs.microsoft.com/en-us/learn/paths/learn-business-value-of-dynamics-365-and-power-platform/
https://docs.microsoft.com/en-us/learn/paths/dyn-power-plat-bus-app-fundamentals/
https://docs.microsoft.com/en-us/learn/paths/get-started-finance-operations/


  

  

Course MB-900T01-A:
Dynamics 365
fundamentals

This course will familiarize
the learner with Dynamics
365 functionality and
business value. The course
will cover Dynamics 365
applications, the Power
Platform, cloud concepts,
the security model, and
licensing considerations.

Instructor-led in person or
online training, cost varies
by region and partner

1 day

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

Core platform knowledge

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

Configure your organization
in Finance and Operations
apps

As a functional consultant
who works with Finance
and Operations apps, you
must understand how to
set up an organization for
your customer. This learning
path shows you, amongst
other tasks, how to set up
legal entities, implement
security settings,
personalize the user
interface for users, design,
and build mobile apps, and
implement common
integrations.

Free, self-paced online
learning path

12 hours

Configure and work with
analytics and reporting in
Finance and Operations
apps

Business leaders can make
important decisions in their
company if they have
accurate insight into the
underlying financial and
operational data. A business
user can also configure, and
use the electronic reporting
tool without a single line of
code, to adopt new
regulatory requirements
and generate business
documents in the required
format to electronically
exchange information with
government bodies, banks,
and other parties.

Free, self-paced online
learning path

4 hours

Supply chain management

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

https://www.microsoft.com/learning/course.aspx?cid=MB-900T01
https://docs.microsoft.com/en-us/learn/paths/configure-your-organization-finance-ops/
https://docs.microsoft.com/en-us/learn/paths/configure-analytics-reporting-finance-operations/


Configure and manage
products and inventory in
Dynamics 365 Supply Chain
Management

Product information is the
pillar of supply chain and
retail applications across all
industries. In the various
modules of a business
solution, product-specific
information and
configuration are required
to manage the business
processes that are related
to products, product
families, bills of materials,
and product categories.
Inventory reports show you
in a variety of ways how
much inventory you have
and explain how to be more
effective in your inventory
investments. Master
planning helps you
streamline your planning
based on predetermined
factors, so you can
efficiently plan what
materials need to be
purchased, transferred, or
manufactured.

Free, self-paced online
learning path

14 hours

Configure and manage
procurement and vendors
in Dynamics 365 Supply
Chain Management

The process of finding and
working with vendors,
purchasing products, and
ensuring the quality of
goods and services are all
important factors that
impact a company's
reputation and success.

Free, self-paced online
learning path

14 hours

Configure and manage
sales, and customers in
Dynamics 365 Supply Chain
Management

The process of working with
customers, understanding
the life cycle of the sales
process, and setting up
sales agreements are all
important factors that
impact a company's success.

Free, self-paced online
learning path

7 hours

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

https://docs.microsoft.com/en-us/learn/paths/configure-manage-products-inventory-dyn365-supply-chain-mgmt/
https://docs.microsoft.com/en-us/learn/paths/configure-manage-procurement-vendors-dyn365-supply-chain-mgmt/
https://docs.microsoft.com/en-us/learn/paths/configure-manage-sales-customers-dyn365-supply-chain-mgmt/


  

Master planning in
Dynamics 365 Supply Chain
Management

Master planning allows
companies to identify and
balance the raw materials
and capacity required to
meet their future goals.
Master planning assesses
which raw materials and
capacities are currently
available, and which raw
materials and capacities are
required to complete
production. For example, it
identifies what must be
manufactured, purchased,
transferred, or set aside as
safety stock before you can
complete production..

Free, self-paced online
learning path

5 hours

Configure and work with
warehouse management in
Dynamics 365 for Finance
and Operations

Warehouse management in
Dynamics 365 Supply Chain
Management helps
optimize and streamline
warehouse processes
according to your individual
needs and provides the
insight into your inventory
and the tools to help
increase customer
satisfaction and reduce
costs.

Free, self-paced online
learning path

8.5 hours

Configure and work with
transportation
management in Dynamics
365 Supply Chain
Management

The Transportation
management module in
Dynamics 365 Supply Chain
Management helps you find
the most efficient way to
deliver goods to your
customers. Transportation
management calculates the
least expensive and fastest
way of delivering goods and
lets you identify vendor and
routing solutions for
inbound and outbound
orders.

Free, self-paced online
learning path

3 hours

Work with Asset
Management for Dynamics
365 Supply Chain
Management

Asset Management is an
add-in to Dynamics 365
Supply Chain Management,
that is used to manage
assets that are used in the
daily operation of your
company. Some examples of
these types of assets are
machinery, production
equipment, and fork lifts.

Free, self-paced online
learning path

12.5 hours

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

Manufacturing

https://docs.microsoft.com/en-us/learn/paths/master-planning-supply-chain-management/
https://docs.microsoft.com/en-us/learn/paths/configure-work-warehouse-management-d365-finance-ops/
https://docs.microsoft.com/en-us/learn/paths/configure-work-transportation-mgmt-dyn365-supply-chain-mgmt/
https://docs.microsoft.com/en-us/learn/paths/work-asset-management-dyn365-supply-chain-mgmt/


C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

Configure and use discrete
manufacturing in Dynamics
365 Supply Chain
Management

If a company only produces
simple products, production
can be scheduled manually
with the correct bill of
materials (BOM) parts
arriving on the production
floor, at the correct time,
and at the proper resource.
As a functional consultant
for manufacturing, you
need to know how to
configure Dynamics 365
Supply Chain Management
for discrete manufacturing,
so your customer can
perform and control the
production lifecycle.

Free, self-paced online
learning path

16.5 hours

Configure and use lean
manufacturing in Dynamics
365 Supply Chain
Management

Lean manufacturing is a
journey of continuous
improvement. The goal is to
produce exactly what the
customer wants, when the
customer wants it, and to
do it economically. You can
use lean manufacturing in a
unified (mixed-mode)
manufacturing environment
that combines various
supply, production, and
sourcing strategies. These
strategies include
production orders, batch
orders for process
industries, purchase orders,
and transfer orders. The
lean manufacturing
architecture in Dynamics
365 Supply Chain
Management consists of
production flows, activities,
and Kanban rules.

Free, self-paced online
learning path

12.5 hours

Configure and use process
manufacturing in Dynamics
365 Supply Chain
Management

Process manufacturing is
associated with formulas
and manufacturing recipes,
in contrast with discrete
manufacturing, which uses
discrete units, and bills of
materials. Process
manufacturing is used in
manufacturing
environments where
production is completed in
batch or semi-continuous
processes.

Free, self-paced online
learning path

10.5 hours

https://docs.microsoft.com/en-us/learn/paths/configure-use-discrete-manufacturing-dyn365-supply-chain-mgmt/
https://docs.microsoft.com/en-us/learn/paths/configure-use-lean-manufacturing-dyn365-supply-chain-mgmt/
https://docs.microsoft.com/en-us/learn/paths/configure-use-process-manufacturing-dyn365-supply-chain-mgmt/


  

Use warehouse
management in
manufacturing in Dynamics
365 for Finance and
Operations

Using warehouse
management in
manufacturing processes in
Dynamics 365 Supply Chain
Management helps
optimize and streamline
warehouse processes in
your manufacturing
environment, according to
your company's needs

Free, self-paced online
learning path

10.5 hours

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

Exam

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT

Dynamics 365 Fundamentals Prove that you understand Microsoft
Dynamics 365, the Power Platform,
cloud concepts, licensing options, and
deployment and release options.

Exam, cost varies by region

NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/learn/paths/use-warehouse-in-manufacturing-dyn365-fo/
https://docs.microsoft.com/en-us/learn/certifications/d365-fundamentals?wt.mc_id=learningredirect_certs-web-wwl
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


  

Learning catalog for implementation project
managers working with Dynamics 365 Supply Chain
Management
2/18/2021 • 16 minutes to read • Edit Online

Get started

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

Learn the business value of
Microsoft Dynamics 365
and the Power Platform

Are you interested in
learning about business
applications? Perhaps you
don’t know where to begin
with Microsoft Dynamics
365 and Power Platform
applications? Learn how the
power of business
applications can help
transform your business.

Free, self-paced online
learning path

7 hours

Dynamics 365 and Power
Platform Fundamentals

Are you interested in
learning about business
applications? Start with this
learning path to see how
Dynamics 365 apps are
used. Learn about cloud
concepts, Power Platform,
and how to get started with
Dynamics 365 apps.

Free, self-paced online
learning path

5.5 hours

Get started with Finance
and Operations apps

Learn how Finance and
Operations apps support
businesses to manage their
global financial systems,
operational business
processes, and streamlined
supply chains to empower
people to make fast,
informed decisions. As the
first step in your career of
working with Finance and
Operations apps, you must
familiarize yourself with its
features and functionality,
whatever your desired role.

Free, self-paced online
learning path

2 hours

Are you in charge of making sure your company’s implementation goes smoothly?

The following catalog is organized from core knowledge to specific domains, and from most basic to most

advanced. If content exists in multiple formats, we'll let you know, so that you can choose the training format

that best meets your needs.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/get-started/learning-catalog-project-manager.md
https://docs.microsoft.com/en-us/learn/paths/learn-business-value-of-dynamics-365-and-power-platform/
https://docs.microsoft.com/en-us/learn/paths/dyn-power-plat-bus-app-fundamentals/
https://docs.microsoft.com/en-us/learn/paths/get-started-finance-operations/


  

Before you buy Check out the step-by-step
guidance whether you're
still evaluating Finance and
Operations or ready to
make a purchase.

Documentation

Release plan Find out about the latest
capabilities and
enhancements in Dynamics
365

Documentation

Get started with Asset
Management for Dynamics
365 Supply Chain
Management

Asset Management is a
module for managing
assets and maintenance
jobs in Dynamics 365
Supply Chain Management.
Asset Management enables
you to efficiently manage
and carry out tasks related
to managing and servicing
many types of equipment in
your company, for example,
machines, production
equipment, and vehicles.
Asset Management
supports solutions across
numerous industries.

Free, self-paced online
learning module

1 hour

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

Core platform knowledge

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

Use Lifecycle Services to
design and plan an
implementation of Finance
and Operations apps

Lifecycle Services (LCS) is a
collaborative workspace
that customers and their
partners use to manage
Finance and Operations
apps projects from pre-
sales to the implementation
phase and finally to the
production environment. It
provides checklists and
tools that help you manage
the project, including pre-
build methodologies to help
with implementation and
regularly updated services.

Free, self-paced online
learning path

2 hours

https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/before-you-buy
https://docs.microsoft.com/en-us/dynamics365/release-plans/
https://docs.microsoft.com/en-us/learn/modules/get-started-asset-management/index
https://docs.microsoft.com/en-us/learn/paths/use-lcs-design-plan-implementation-finance-operations/


Configure your organization
in Finance and Operations
apps

As a functional consultant
who works with Finance
and Operations apps, you
must understand how to
set up an organization for
your customer. This learning
path shows you, amongst
other tasks, how to set up
legal entities, implement
security settings,
personalize the user
interface for users, design,
and build mobile apps, and
implement common
integrations.

Free, self-paced online
learning path

12 hours

Migrate data and go live
with Finance and
Operations apps

As a functional consultant,
you must understand how
to prepare your customer's
data for migration, work
with data management, and
perform user acceptance
testing to go live with
Finance and Operations
apps.

Free, self-paced online
learning path

4 hours

Configure and work with
analytics and reporting in
Finance and Operations
apps

Business leaders can make
important decisions in their
company if they have
accurate insight into the
underlying financial and
operational data. A business
user can also configure, and
use the electronic reporting
tool without a single line of
code, to adopt new
regulatory requirements
and generate business
documents in the required
format to electronically
exchange information with
government bodies, banks,
and other parties.

Free, self-paced online
learning path

4 hours

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

https://docs.microsoft.com/en-us/learn/paths/configure-your-organization-finance-ops/
https://docs.microsoft.com/en-us/learn/paths/migrate-data-go-live-finance-operations/
https://docs.microsoft.com/en-us/learn/paths/configure-analytics-reporting-finance-operations/


Finance and Operations:
Onboarding to Dynamics
365 (DYN542PAL2)

FastTrack offers an
Onboarding service to
every Dynamics 365 for
Finance and Operations
project. In this TechTalk, we
will explain the Onboarding
process, walk through the
content of the Onboarding
session with you, and unveil
how we are making
Onboarding more efficient
and convenient in the near
future. This session is
especially relevant to
everybody who works with
customers in the early
stages of a project, between
closing the license deal and
initiation of the
implementation project.

Tech Talk (recorded webinar) 62 minutes

On-Premises (Local
Business Data) Deployment
(DYN382PAL2)

Please join this tech talk for
an overview of the on-
premises deployment
option for Dynamics 365
for Finance and Operations,
Enterprise Edition. In this
session, we will look at the
solution architecture of an
on-premises deployment,
ALM aspects, system
requirements, and how to
provision the Life Cycle
Services project.

Tech Talk (recorded webinar) 48 minutes

Go-live Planning
(DYN458PAL2)

We will discuss the go-live
process in detail, and how
best to prepare for it, in
order to make it as smooth
as possible for the
customer, partner and
Microsoft.

Tech Talk (recorded webinar) 60 minutes

Environment Planning
(DYN450PAL2)

Please join us for this tech
talk on Environment
Planning. Learn about the
standard environments,
what other environments
you might need, the
options and timing for
acquiring and deploying
them, and the expected
code and data flows
between environments.

Tech Talk (recorded webinar) 53 minutes

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-onboarding-to-dynamics-365-1-10-19
https://community.dynamics.com/365/b/techtalks/posts/on-premises-local-business-data-deployment-october-19-2017
https://community.dynamics.com/365/b/techtalks/posts/go-live-planning-8-9-18
https://community.dynamics.com/365/b/techtalks/posts/environment-planning-may-23-2018


Finance and Operations:
Feature Management
(DYN641PAL2)

Tech Talk on the Feature
management experience. It
provides a workspace where
you can view, enable,
disable, and schedule
features that have been
delivered in each release. By
default, new features are
turned off. You can use the
workspace to turn them on
and view the
documentation for them.
Attend this meeting to see
what is delivered in 10.0.3
and our plans for future
releases.

Tech Talk (recorded webinar) 47 minutes

Finance And Operations:
Microsoft Managed
Continuous Updates
(DYN610PAL)

The Continuous Update
cadence for Finance and
Operations has started!
Please join us during this
hour to discuss Microsoft
Managed Continuous
updates, the user
experience already available
in Lifecycle Services, and
forthcoming updates.

Tech Talk (recorded webinar) 61 minutes

Microsoft Managed
Continuous Updates:
What's new (DYN543PAL2)

During this hour we will
explain what is new since
our initial announcements
about Microsoft Managed
Continuous updates. We
will discuss the cadence of
updates, how we have
responded to your valuable
feedback on the process,
and take a look at the
forthcoming Lifecycle
Services user experience,
through which you will be
able to manage your
updates.

Tech Talk (recorded webinar) 56 minutes

Monitoring, Optimization
Advisor & Critical KBs
(DYN456PAL2)

We will discuss monitoring
capabilities and what
Microsoft monitors for you
in your production
environment, the
optimization advisor and
how it can be extended, the
“Critical X++ updates”
experience in LCS, and best
practices for the “Report
production outage” option
in LCS.

Tech Talk (recorded webinar) 40 minutes

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-feature-management-may-17-2019
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-microsoft-managed-continuous-updates-april-2-2019
https://community.dynamics.com/365/b/techtalks/posts/microsoft-managed-continuous-updates-what-39-s-new-12-13-18
https://community.dynamics.com/365/b/techtalks/posts/monitoring-optimization-advisor-amp-critical-kbs-july-13-2018


Visual Studio Team Services
(VSTS) Setup (VIR782PAL)

This Tech Talk will walk thru
the necessary steps to
configure a VSTS instance
and project to connect to
LCS implementation project
for Dev/Test environment
configuration.

Tech Talk (recorded webinar) 41 minutes

Copy Into Legal Entity
(DYN383PAL)

In this session, we will
discuss a new feature in the
data management
framework, Copy into legal
entity. We will first briefly
review the new features
added to the data
management framework in
platform 8 for the
workspace, templates, and
data projects and then
discuss the additional
functionality added for
Copy into legal entity.

Tech Talk (recorded webinar) 54 minutes

Regression Suite
Automation Tool
(DYN480PAL)

We will discuss the
Regression Suite
Automation Tool. It
significantly reduces the
time and cost of user
acceptance testing, when
taking a Microsoft update,
or before applying custom
code and configurations to
your Dynamics 365 for
Finance and Operations
production environment. It
enables functional power
users to record business
tasks, using the Finance and
Operations task recorder,
and convert them into a
suite of automated tests,
without the need to write
source code.

Tech Talk (recorded webinar) 61 minutes

Finance and Operations:
Regression Suite
Automation Tool --
Background & Setup
(DYN646PAL)

This is the first of a two-
part series on Regression
Suite Automation Testing
(RSAT). In this session, we
will cover how to keep pace
with continuous updates
using automated testing via
RSAT. Learnings and
recommendations on
creating task recordings
and executing tests using
RSAT will be covered, along
with a step-by-step
walkthrough of the
installation and setup.

Tech Talk (recorded webinar) 70 minutes
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https://community.dynamics.com/365/b/techtalks/posts/visual-studio-team-services-vsts-setup-january-17-2017
https://community.dynamics.com/365/b/techtalks/posts/copy-into-legal-entity-october-24-2017
https://community.dynamics.com/365/b/techtalks/posts/regression-suite-automation-tool-9-25-18
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-regression-suite-automation-tool-background-amp-setup-may-28-2019


Finance and Operations:
Regression Suite
Automation Tool -- Testing
Lifecycle Demo
(DYN647PAL)

This is the second of a two-
part series on Regression
Suite Automation Testing
(RSAT). This session will
cover a demo of the whole
cycle of creating and saving
task recordings from
Finance and Operations to
the BPM library in LCS,
synchronizing the BPM
library to create test cases
in Azure DevOps, grouping
the test cases into test
suites, and loading and
executing the test suites in
RSAT.

Tech Talk (recorded webinar) 70 minutes

Performance Testing
Approach (DYN449PAL2)

Please join us for this tech
talk on how to approach
Performance Testing. Learn
about the fundamentals,
best practices for testing,
available tools and
techniques for executing
tests and measuring
performance, and how to
use the results for
optimization.

Tech Talk (recorded webinar) 45 minutes

How to upgrade to 7.2 (July
2017) from 7.0 (RTW)/7.1
(Release 1611)
(DYN338PAL2)

In this session we will
explain how to upgrade
from Dynamics 365 Finance
and Operations application
v7.0 (RTW) and v7.1 (1611)
to v7.2 (July 2017). We
make a clear differentiation
between Live customers
and ongoing projects (not
live yet).

Tech Talk (recorded webinar) 58 minutes

Finance and Operations:
Upgrading from 7.x to 8+
(DYN519PAL2)

Please join us for our next
TechTalk, during which we
will cover the 7.X to 8.X
upgrade process. We will
discuss various scenarios
and steps to execute for
code upgrade and data
upgrade. We will also cover
extensibility request
scenarios and how to raise
them where appropriate.
Part 1 of 2.

Tech Talk (recorded webinar) 61 minutes

AX2012 to Dynamics 365
for Operations Upgrade
(VIR817PAL2)

This Tech Talk will provide an
overview on how to
upgrade code and data
from Dynamics AX 2012 to
Dynamics 365 for
Operations.

Tech Talk (recorded webinar) 45 minutes
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https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-regression-suite-automation-tool-testing-lifecycle-demo-may-29-2019
https://community.dynamics.com/365/b/techtalks/posts/performance-testing-approach-april-30-2018
https://community.dynamics.com/365/b/techtalks/posts/how-to-upgrade-to-7-2-july-2017-from-7-0-rtw-7-1-release-1611-august-3-2017
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-upgrading-from-7-x-to-8-10-30-18
https://community.dynamics.com/365/b/techtalks/posts/ax2012-to-dynamics-365-for-operations-upgrade-april-20-2017


  

Analytics & Reporting
Options: Printing and the
Document Routing Agent

Please join us for this tech
talk on two related topics.
First we will discuss
Analytics and Reporting
solution patterns and tools
for Dynamics 365 for
Finance and Operations,
Enterprise Edition. Secondly,
we will discuss printing
scenarios and the
Document Routing Agent.

Tech Talk (recorded webinar) 45 minutes

Course MB-300T01-A: Core
common features of
Dynamics 365 for Finance
and Operations

This course discusses core
common features of
Microsoft Dynamics 365 for
Finance and Operations.

Instructor-led in person or
online training, cost varies
by region and partner

1 day

Course MB-300T02-A: Core
configuration in Dynamics
365 for Finance and
Operations

This course discusses core
configuration tasks for
Microsoft Dynamics 365 for
Finance and Operations.

Instructor-led in person or
online training, cost varies
by region and partner

1 day

Course MB-300T03-A: Data
migration and preparing for
go-live with Dynamics 365
for Finance and Operations

This course discusses data
migration and go-live
preparation for Microsoft
Dynamics 365 for Finance
and Operations.

Instructor-led in person or
online training, cost varies
by region and partner

1 day

Implementation Lifecycle
home page

These topics describe the
programs, tools, and
processes available related
to the implementation
lifecycle of your Microsoft
Dynamics 365 for Finance
and Operations project.

Documentation
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Supply chain management
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https://community.dynamics.com/365/b/techtalks/posts/analytics-amp-reporting-options-printing-and-the-document-routing-agent-february-8-2018
https://www.microsoft.com/learning/course.aspx?cid=MB-300T01
https://www.microsoft.com/learning/course.aspx?cid=MB-300T02
https://www.microsoft.com/learning/course.aspx?cid=MB-300T03
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/imp-lifecycle/implementation-lifecycle


Configure and manage
products and inventory in
Dynamics 365 Supply Chain
Management

Product information is the
pillar of supply chain and
retail applications across all
industries. In the various
modules of a business
solution, product-specific
information and
configuration are required
to manage the business
processes that are related
to products, product
families, bill of materials,
and product categories.
Inventory reports will show
how much inventory you
have in variety of different
ways, and will explain how
to be more effective in your
inventory investments.

Free, self-paced online
learning path

6 hours

Configure and manage
procurement and vendors
in Dynamics 365 Supply
Chain Management

The process of finding and
working with vendors,
purchasing products, and
ensuring the quality of
goods and services are all
important factors that
impact a company's
reputation and success.

Free, self-paced online
learning path

6 hours

Configure and work with
warehouse management in
Dynamics 365 for Finance
and Operations

Warehouse management in
Dynamics 365 for Finance
and Operations helps
optimize and streamline
warehouse processes
according to your individual
needs and provides the
insight into your inventory
and the tools to help
increase customer
satisfaction and reduce
costs.

Free, self-paced online
learning path

5 hours

Configure and work with
transportation
management in Dynamics
365 Supply Chain
Management

The Transportation
management module in
Dynamics 365 Supply Chain
Management helps you find
the most efficient way to
deliver goods to your
customers. Transportation
management calculates the
least expensive and fastest
way of delivering goods and
lets you identify vendor and
routing solutions for
inbound and outbound
orders.

Free, self-paced online
learning path

3 hours
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https://docs.microsoft.com/en-us/learn/paths/configure-manage-products-inventory-dyn365-supply-chain-mgmt/
https://docs.microsoft.com/en-us/learn/paths/configure-manage-procurement-vendors-dyn365-supply-chain-mgmt/
https://docs.microsoft.com/en-us/learn/paths/configure-work-warehouse-management-d365-finance-ops/
https://docs.microsoft.com/en-us/learn/paths/configure-work-transportation-mgmt-dyn365-supply-chain-mgmt/


Warehousing Mobile App
(VIR816PAL)

This Tech Talk will discuss
the Advanced Warehousing
system in Dynamics 365 for
Operations and what the
future holds for the
advanced warehousing
mobile interface. We will
examine the new mobile
application that has been
released and how it
compares to the legacy
WMDP. We will learn what is
required to install,
configure, and operate this
mobile application and how
it can be used to benefit
your implementations.

Free recording of a web
conference

54 minutes

Vendor Collaboration
(DYN327PAL)

This Tech Talk will provide a
walk through on the
Vendor Collaboration
feature including the
Consumption of Response
from Vendor feature that is
included in the July (spring)
release.

Free recording of a web
conference

58 minutes

Item And Warehouse
Migration Process To Use
Advanced Warehouse
Management (DYN316PAL)

In this Tech Talk, we will
teach you how to migrate
existing warehouse setup
and items with open
transactions to the advance
warehouse management,
by using the new
capabilities to change the
storage dimension group
for items and enable
warehouses to use the
advanced warehouse
management processes.

Free recording of a web
conference

54 minutes

Supply chain management
home page

This topic provides a list of
the help topics and other
resources for the supply
chain management features
in Microsoft Dynamics 365
for Finance and Operations.

Documentation

Demand Replenishment for
Raw Material Picking
(DYN333PAL2)

This TechTalk will cover raw
material picking and
demand replenishment for
raw material picking.

Free recording of a web
conference

38 minutes

Course MB-330T01-A:
Configure and use supply
chain management in
Dynamics 365 for Finance
and Operations

This course discusses how
to configure and use supply
chain management in
Dynamics 365 for Finance
and Operations.

Instructor-led in person or
online training, cost varies
by region and partner

2 days
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https://community.dynamics.com/365/b/techtalks/posts/warehousing-mobile-app-march-22-2017
https://community.dynamics.com/365/b/techtalks/posts/vendor-collaboration-july-25-2017
https://community.dynamics.com/365/b/techtalks/posts/item-and-warehouse-migration-process-to-use-advanced-warehouse-management-june-27-2017
https://docs.microsoft.com/en-us/dynamics365/unified-operations/supply-chain/
https://community.dynamics.com/365/b/techtalks/posts/demand-replenishment-for-raw-material-picking-september-28-2017
https://www.microsoft.com/learning/course.aspx?cid=MB-330T01


  

Course MB-330T02-A: Use
quality management,
Intercompany trading and
master planning in
Dynamics 365 for Finance
and Operations

This course discusses how
to use quality management,
intercompany trading and
master planning in
Dynamics 365 for Finance
and Operations.

Instructor-led in person or
online training, cost varies
by region and partner

1 day

Course MB-330T03-A:
Configure and use
warehouse, and
transportation
management in Dynamics
365 for Finance and
Operations

This course discusses how
to configure and use
warehouse and
transportation
management in Dynamics
365 for Finance and
Operations.

Instructor-led in person or
online training, cost varies
by region and partner

1 day
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Manufacturing
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Configure and use discrete
manufacturing in Dynamics
365 Supply Chain
Management

If a company only produces
simple products, production
can be scheduled manually
with the correct bill of
materials (BOM) parts
arriving on the production
floor, at the correct time,
and at the proper resource.
As a functional consultant
for manufacturing, you
need to know how to
configure Dynamics 365 for
Finance and Operations for
discrete manufacturing, so
your customer can perform
and control the production
lifecycle.

Free, self-paced online
learning path

9 hours

https://www.microsoft.com/learning/course.aspx?cid=MB-330T02
https://www.microsoft.com/learning/course.aspx?cid=MB-330T03
https://docs.microsoft.com/en-us/learn/paths/configure-use-discrete-manufacturing-dyn365-supply-chain-mgmt/


Configure and use lean
manufacturing in Dynamics
365 Supply Chain
Management

Lean manufacturing is a
journey of continuous
improvement. The goal is to
produce exactly what the
customer wants, when the
customer wants it, and to
do it economically. You can
use lean manufacturing in a
unified (mixed-mode)
manufacturing environment
that combines various
supply, production, and
sourcing strategies. These
strategies include
production orders, batch
orders for process
industries, purchase orders,
and transfer orders. The
lean manufacturing
architecture in Dynamics
365 for Finance and
Operations consists of
production flows, activities,
and Kanban rules.

Free, self-paced online
learning path

6.5 hours

Configure and use process
manufacturing in Dynamics
365 Supply Chain
Management

Process manufacturing is
associated with formulas
and manufacturing recipes,
in contrast with discrete
manufacturing, which uses
discrete units, and bills of
materials. Process
manufacturing is used in
manufacturing
environments where
production is completed in
batch or semi-continuous
processes.

Free, self-paced online
learning path

6 hours

Use warehouse
management in
manufacturing in Dynamics
365 for Finance and
Operations

Using warehouse
management in
manufacturing processes in
Dynamics 365 for Finance
and Operations helps
optimize and streamline
warehouse processes in
your manufacturing
environment, according to
your company's needs.

Free, self-paced online
learning path

6 hours

Course MB-320T01-A:
Configure and use discrete
manufacturing in Dynamics
365 for Finance and
Operations

This course discusses how
to configure and use
discrete manufacturing in
Dynamics 365 for Finance
and Operations.

Instructor-led in person or
online training, cost varies
by region and partner

2 days
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https://docs.microsoft.com/en-us/learn/paths/configure-use-lean-manufacturing-dyn365-supply-chain-mgmt/
https://docs.microsoft.com/en-us/learn/paths/configure-use-process-manufacturing-dyn365-supply-chain-mgmt/
https://docs.microsoft.com/en-us/learn/paths/use-warehouse-in-manufacturing-dyn365-fo/
https://www.microsoft.com/learning/course.aspx?cid=MB-320T01


  

Course MB-320T02-A:
Configure and use lean
manufacturing in Dynamics
365 for Finance and
Operations

This course discusses how
to configure and use lean
manufacturing in Dynamics
365 for Finance and
Operations.

Instructor-led in person or
online training, cost varies
by region and partner

1 day

Course MB-320T03-A:
Configure and use process
manufacturing in Dynamics
365 for Finance and
Operations

This course discusses how
to configure and use
process manufacturing in
Dynamics 365 for Finance
and Operations.

Instructor-led in person or
online training, cost varies
by region and partner

1 day
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Exams
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Microsoft Certified: Dynamics 365 for
Finance and Operations, Supply Chain
Management Functional Consultant
Associate

Microsoft Certified: Dynamics 365 for
Finance and Operations, Supply Chain
Management Functional Consultants
streamline cost accounting, inventory
management, master planning, and
warehouse management for their
clients.

Certification, cost varies by region

Microsoft Certified: Dynamics 365 for
Finance and Operations,
Manufacturing Functional Consultant
Associate

Microsoft Certified: Dynamics 365 for
Finance and Operations,
Manufacturing Functional Consultants
integrate digital and physical systems;
improve visibility, manufacturing
efficiency and flexibility; and lower
costs for their clients.

Certification, cost varies by region

Exam MB-300: Microsoft Dynamics
365 Unified Operations Core

This exam measures your ability to
accomplish the following technical
tasks: use common functionality and
implementation tools; configure
security, processes, and options;
perform data migration; and validate
and support the solution.

Exam, cost varies by region

Exam MB-320: Microsoft Dynamics
365 for Finance and Operations,
Manufacturing

This exam measures your ability to
accomplish the following technical
tasks: set up and configure
manufacturing; create and manage
production and lean orders; and
create, process, and manage
production batch orders.

Exam, cost varies by region

Exam MB-330: Microsoft Dynamics
365 for Finance and Operations,
Supply Chain Management

This exam measures your ability to
accomplish the following technical
tasks: implement product information
management; implement inventory
management; implement and manage
supply chain processes; and implement
warehouse management and
transportation management and
perform business processes.

Exam, cost varies by region

https://www.microsoft.com/learning/course.aspx?cid=MB-320T02
https://www.microsoft.com/learning/course.aspx?cid=MB-320T03
https://www.microsoft.com/learning/d365-functional-consultant-supply-chain-management.aspx
https://www.microsoft.com/learning/d365-functional-consultant-manufacturing.aspx
https://docs.microsoft.com/en-us/learn/certifications/exams/mb-300?wt.mc_id=learningredirect_certs-web-wwl
https://docs.microsoft.com/en-us/learn/certifications/exams/mb-320?wt.mc_id=learningredirect_certs-web-wwl
https://docs.microsoft.com/en-us/learn/certifications/exams/mb-330?wt.mc_id=learningredirect_certs-web-wwl
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Learning catalog for Dynamics 365 Supply Chain
Management administrators
2/18/2021 • 8 minutes to read • Edit Online

Get Started
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Dynamics 365 and Power
Platform Fundamentals

Are you interested in
learning about business
applications? Start with this
learning path to see how
Dynamics 365 apps are
used. Learn about cloud
concepts, Power Platform,
and how to get started with
Dynamics 365 apps.

Free, self-paced online
learning path

5.5 hours

Get started with Finance
and Operations apps

Learn how Finance and
Operations apps support
businesses to manage their
global financial systems,
operational business
processes, and streamlined
supply chains to empower
people to make fast,
informed decisions. As the
first step in your career of
working with Finance and
Operations apps, you must
familiarize yourself with its
features and functionality,
whatever your desired role.

Free, self-paced online
learning path

2 hours

Course MB-900T01-A:
Dynamics 365
fundamentals

This course will familiarize
the learner with Dynamics
365 functionality and
business value. The course
will cover Dynamics 365
applications, the Power
Platform, cloud concepts,
the security model, and
licensing considerations.

Instructor-led in person or
online training, cost varies
by region and partner

1 day

Core platform knowledge

Do you need to keep systems and data flowing, provisioned, and secure round-the-clock?

The following catalog is organized from core knowledge to specific domains, and from most basic to most

advanced. If content exists in multiple formats, we'll let you know, so that you can choose the training format

that best meets your needs.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/get-started/learning-catalog-administrator.md
https://docs.microsoft.com/en-us/learn/paths/dyn-power-plat-bus-app-fundamentals/
https://docs.microsoft.com/en-us/learn/paths/get-started-finance-operations/
https://www.microsoft.com/learning/course.aspx?cid=MB-900T01
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Use Lifecycle Services to
design and plan an
implementation of Finance
and Operations apps

Lifecycle Services (LCS) is a
collaborative workspace
that customers and their
partners use to manage
Finance and Operations
apps projects from pre-
sales to the implementation
phase and finally to the
production environment. It
provides checklists and
tools that help you manage
the project, including pre-
build methodologies to help
with implementation and
regularly updated services.

Free, self-paced online
learning path

2 hours

Configure your organization
in Finance and Operations
apps

As a functional consultant
who works with Finance
and Operations apps, you
must understand how to
set up an organization for
your customer. This learning
path shows you, amongst
other tasks, how to set up
legal entities, implement
security settings,
personalize the user
interface for users, design,
and build mobile apps, and
implement common
integrations.

Free, self-paced online
learning path

12 hours

Migrate data and go live
with Finance and
Operations apps

As a functional consultant,
you must understand how
to prepare your customer's
data for migration, work
with data management, and
perform user acceptance
testing to go live with
Finance and Operations
apps.

Free, self-paced online
learning path

4 hours

Work with analytics and
reporting in Finance and
Operation

Business leaders can make
important decisions in their
company if they have
accurate insight into the
underlying financial and
operational data. Without
data visibility, business
leaders are challenged with
a nearly impossible task. By
using analytics and
reporting in Finance and
Operations apps, you can
empower every business
user, depending on their
security rights, to get the
insights they need to make
those important decisions.

Free, self-paced online
learning path

1.5 hours

https://docs.microsoft.com/en-us/learn/paths/use-lcs-design-plan-implementation-finance-operations/
https://docs.microsoft.com/en-us/learn/paths/configure-your-organization-finance-ops/
https://docs.microsoft.com/en-us/learn/paths/migrate-data-go-live-finance-operations/
https://docs.microsoft.com/en-us/learn/modules/work-with-analytics-reporting-in-dynamics-365-finance-ops/


Manage an implementation
project for Finance and
Operations

Learn the most important
elements and the best
practices to manage a
successful Finance and
Operations implementation
project. From the first step
where you are planning and
designing your project
methodology, the use of
FastTrack services, the
development strategy, data
management and more, to
the best ways for
maintaining and monitoring
your operations after Go-
live.

Free, self-paced online
learning path

11.5 hours

System administration
home page

This topic points to content
for system administrators of
Microsoft Dynamics 365 for
Finance and Operations.
This content will help you
configure the system so
that it works smoothly and
effectively for your
organization.

Documentation

Finance and Operations:
Onboarding to Dynamics
365 (DYN542PAL2)

FastTrack offers an
Onboarding service to
every Dynamics 365 for
Finance and Operations
project. In this TechTalk, we
will explain the Onboarding
process, walk through the
content of the Onboarding
session with you, and unveil
how we are making
Onboarding more efficient
and convenient in the near
future. This session is
especially relevant to
everybody who works with
customers in the early
stages of a project, between
closing the license deal and
initiation of the
implementation project.

Free recording of a web
conference

62 minutes
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https://docs.microsoft.com/en-us/learn/paths/implement-finance-operations/
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/sysadmin/system-administration-home-page
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-onboarding-to-dynamics-365-1-10-19


  

  

On-Premises (Local
Business Data) Deployment
(DYN382PAL2)

Please join this tech talk for
an overview of the on-
premises deployment
option for Dynamics 365
for Finance and Operations,
Enterprise Edition. In this
session, we will look at the
solution architecture of an
on-premises deployment,
ALM aspects, system
requirements, and how to
provision the Life Cycle
Services project.

Free recording of a web
conference

48 minutes

Copy Into Legal Entity
(DYN383PAL)

In this session, we will
discuss a new feature in the
data management
framework, Copy into legal
entity. We will first briefly
review the new features
added to the data
management framework in
platform 8 for the
workspace, templates, and
data projects and then
discuss the additional
functionality added for
Copy into legal entity.

Free recording of a web
conference

54 minutes
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Core development
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Data Management
(DYN757PAL2)

Please join us for this
TechTalk on Data
Management. Learn about
the options available and
the scenarios for which they
are recommended. We will
cover the Data
Management framework,
templates, database
copying, cross-company
data sharing, and
performance considerations.

Free recording of a web
conference

58 minutes

Migration and upgrade
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https://community.dynamics.com/365/b/techtalks/posts/on-premises-local-business-data-deployment-october-19-2017
https://community.dynamics.com/365/b/techtalks/posts/copy-into-legal-entity-october-24-2017
https://community.dynamics.com/365/b/techtalks/posts/dynamics-365-finance-scm-data-management-february-14-2020


  

Finance and Operations:
Upgrading from 7.x to 8+
(DYN519PAL2)

Please join us for our next
TechTalk, during which we
will cover the 7.X to 8.X
upgrade process. We will
discuss various scenarios
and steps to execute for
code upgrade and data
upgrade. We will also cover
extensibility request
scenarios and how to raise
them where appropriate.

Free recording of a web
conference

61 minutes

How to upgrade to 7.2 (July
2017) from 7.0 (RTW)/7.1
(Release 1611)
(DYN338PAL2)

In this session we will
explain how to upgrade
from Dynamics 365 Finance
and Operations application
v7.0 (RTW) and v7.1 (1611)
to v7.2 (July 2017). We
make a clear differentiation
between Live customers
and ongoing projects (not
live yet).

Free recording of a web
conference

58 minutes

AX2012 to Dynamics 365
for Operations Upgrade
(VIR817PAL2)

This Tech Talk will provide an
overview on how to
upgrade code and data
from Dynamics AX 2012 to
Dynamics 365 for
Operations.

Free recording of a web
conference

45 minutes

AX2009 Migration Tool This session will cover
tooling available to assist
you with migrating from
AX2009 to D365 for
Operations.

Free recording of a web
conference

55 minutes
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Servicing
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Finance and Operations:
Feature Management
(DYN641PAL2)

Tech Talk on the Feature
management experience. It
provides a workspace where
you can view, enable,
disable, and schedule
features that have been
delivered in each release. By
default, new features are
turned off. You can use the
workspace to turn them on
and view the
documentation for them.
Attend this meeting to see
what is delivered in 10.0.3
and our plans for future
releases.

Free recording of a web
conference

47 minutes

https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-upgrading-from-7-x-to-8-10-30-18
https://community.dynamics.com/365/b/techtalks/posts/how-to-upgrade-to-7-2-july-2017-from-7-0-rtw-7-1-release-1611-august-3-2017
https://community.dynamics.com/365/b/techtalks/posts/ax2012-to-dynamics-365-for-operations-upgrade-april-20-2017
https://community.dynamics.com/365/b/techtalks/posts/ax2009-migration-tool-may-11-2017
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-feature-management-may-17-2019


Finance and Operations:
Servicing, Supporting and
Maintaining Production
(DYN651PAL2)

Tech Talk on how to
efficiently support, maintain
and service your Dynamics
365 for Finance and
Operations production
environment.

Free recording of a web
conference

53 minutes

Finance And Operations:
Microsoft Managed
Continuous Updates
(DYN610PAL)

The Continuous Update
cadence for Finance and
Operations has started!
Please join us during this
hour to discuss Microsoft
Managed Continuous
updates, the user
experience already available
in Lifecycle Services, and
forthcoming updates.

Free recording of a web
conference

61 minutes

Microsoft Managed
Continuous Updates:
What's new (DYN543PAL2)

During this hour we will
explain what is new since
our initial announcements
about Microsoft Managed
Continuous updates. We
will discuss the cadence of
updates, how we have
responded to your valuable
feedback on the process,
and take a look at the
forthcoming Lifecycle
Services user experience,
through which you will be
able to manage your
updates.

Free recording of a web
conference

56 minutes

Microsoft Managed
Continuous Updates
(DYN474PAL2)

We will discuss Microsoft’s
plans for keeping your
system up-to-date with the
latest release. We will cover
timelines, the cadence for
major and minor updates,
the planned procedures, the
implications, and what you
should do for optimal
results.

Free recording of a web
conference

62 minutes

Monitoring, Optimization
Advisor & Critical KBs
(DYN456PAL2)

We will discuss monitoring
capabilities and what
Microsoft monitors for you
in your production
environment, the
optimization advisor and
how it can be extended, the
“Critical X++ updates”
experience in LCS, and best
practices for the “Report
production outage” option
in LCS.

Free recording of a web
conference

40 minutes
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https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-servicing-supporting-and-maintaining-production-june-27-2019
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-microsoft-managed-continuous-updates-april-2-2019
https://community.dynamics.com/365/b/techtalks/posts/microsoft-managed-continuous-updates-what-39-s-new-12-13-18
https://community.dynamics.com/365/b/techtalks/posts/microsoft-managed-continuous-updates-september-5-2018
https://community.dynamics.com/365/b/techtalks/posts/monitoring-optimization-advisor-amp-critical-kbs-july-13-2018


  

  

Testing
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Finance and Operations:
Regression Suite
Automation Tool --
Background & Setup
(DYN646PAL)

This is the first of a two-
part series on Regression
Suite Automation Testing
(RSAT). In this session, we
will cover how to keep pace
with continuous updates
using automated testing via
RSAT. Learnings and
recommendations on
creating task recordings
and executing tests using
RSAT will be covered, along
with a step-by-step
walkthrough of the
installation and setup.

Free recording of a web
conference

70 minutes

Finance and Operations:
Regression Suite
Automation Tool -- Testing
Lifecycle Demo
(DYN647PAL)

This is the second of a two-
part series on Regression
Suite Automation Testing
(RSAT). This session will
cover a demo of the whole
cycle of creating and saving
task recordings from
Finance and Operations to
the BPM library in LCS,
synchronizing the BPM
library to create test cases
in Azure DevOps, grouping
the test cases into test
suites, and loading and
executing the test suites in
RSAT.

Free recording of a web
conference

70 minutes

Finance and Operations:
Performance
Troubleshooting Tools for
Dynamics 365
(DYN541PAL2)

In this Tech Talk, we will
present the different tools
that can be used to
troubleshoot Microsoft
Dynamics 365 for Finance
and Operations
performance issues. This
session will contain some
scenario-based
demonstrations and initial
guidance on how to
approach typical
performance issues.

Free recording of a web
conference

64 minutes

Exam
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Dynamics 365 Fundamentals Prove that you understand Microsoft
Dynamics 365, the Power Platform,
cloud concepts, licensing options, and
deployment and release options.

Exam, cost varies by region

https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-regression-suite-automation-tool-background-amp-setup-may-28-2019
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-regression-suite-automation-tool-testing-lifecycle-demo-may-29-2019
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-performance-troubleshooting-tools-for-dynamics-365-12-14-18
https://docs.microsoft.com/en-us/learn/certifications/d365-fundamentals?wt.mc_id=learningredirect_certs-web-wwl


NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


  

  

Learning catalog for Dynamics 365 Supply Chain
Management developers
2/18/2021 • 11 minutes to read • Edit Online

NOTENOTE

Get started
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Get started with Finance
and Operations apps

Learn how Finance and
Operations apps support
businesses to manage their
global financial systems,
operational business
processes, and streamlined
supply chains to empower
people to make fast,
informed decisions. As the
first step in your career of
working with Finance and
Operations apps, you must
familiarize yourself with its
features and functionality,
whatever your desired role.

Free, self-paced online
learning path

2.2 hours

Core development concepts
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Effective November 2020:

Common Data Service has been renamed to Microsoft Dataverse. For more information, see Power Automate Blog.

Some terminology in Microsoft Dataverse has been updated. For example, entity is now table and field is now column.

For more information, see Terminology updates.

This topic will be updated soon to reflect the latest terminology.

Do you need to write code to integrate with other data sources, extend core system functionality, or build a

complex application?

The following catalog is organized from core knowledge to specific domains, and from most basic to most

advanced. If content exists in multiple formats, we'll let you know, so that you can choose the training format

that best meets your needs.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/get-started/learning-catalog-developer.md
https://aka.ms/PAuAppBlog
https://go.microsoft.com/fwlink/?linkid=2147247
https://docs.microsoft.com/en-us/learn/paths/get-started-finance-operations/


Introduction to developing
with Finance and
Operations apps

As a developer working
with Finance and
Operations apps, it's
important to have a firm
grasp of the main
architecture components of
the Dynamics 365
ecosystem and Finance and
Operations apps.
Knowledge of core
developer concepts,
including technical
capabilities, source code,
testing frameworks, and
reporting tools, will support
your further efforts in
building development skills
that you can apply to
Finance and Operations
apps.

Free, self-paced online
learning path

7.75 hours

Build Finance and
Operations apps

Developing in Finance and
Operations apps requires a
basic understanding of the
tasks required to build new
elements and customize
Finance and Operations
apps. The tasks include
understanding X++ code
and Visual Studio, as well as
being able to create and
modify the basic elements
of the system.

Free, self-paced online
learning path

13 hours

Extend Finance and
Operations apps

Extensions allow developers
to make changes to the
user experience in Finance
and Operations apps by
implementing modifications
to the code that do not
affect the base code.
Among other benefits,
extensions let developers
update Finance and
Operations apps to adhere
to business processes and
required changes.

Free, self-paced online
learning path

2.5 hours
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https://docs.microsoft.com/en-us/learn/paths/introduction-develop-finance-operations/
https://docs.microsoft.com/en-us/learn/paths/build-finance-operations/
https://docs.microsoft.com/en-us/learn/paths/extending-finance-operations/


Connect to Finance and
Operations apps

Integration and the ability
to access your data in
Finance and Operations
apps are important
capabilities. Developers who
have learned to build and
extend code in Finance and
Operations apps can
enhance their knowledge of
development by learning
about data integration and
how connecting to data can
have positive impacts on
users.

Free, self-paced online
learning path

5.75 hours

Migrate data and go live
with Finance and
Operations apps

As a functional consultant,
you must understand how
to prepare your customer's
data for migration, work
with data management, and
perform user acceptance
testing to go live with
Finance and Operations
apps.

Free, self-paced online
learning path

4 hours

Finance And Operations:
Development ALM
(DYN766PAL)

This TechTalk discusses
Development Application
Lifecycle Management
concepts, tools and the best
practices we recommend.
We cover how Lifecycle
Services, Visual Studio, and
Azure DevOps work
together to enable
business-process focused
continuous delivery of your
solution’s code base, and
servicing of your
environments.

Free recording of a web
conference

52 minutes

Finance and Operations:
Extending Dynamics 365 for
Finance and Operations
with PowerApps
(DYN558PAL2)

Understand the simplicity of
Microsoft PowerApps and
how it can integrate with
Dynamics 365 for Finance
and Operations to digitally
transform businesses and
increase user productivity.

Free recording of a web
conference

43 minutes
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https://docs.microsoft.com/en-us/learn/paths/connect-finance-operations/
https://docs.microsoft.com/en-us/learn/paths/migrate-data-go-live-finance-operations/
https://community.dynamics.com/365/b/techtalks/posts/dynamics-365-finance-and-operations---development-alm-february-19-2020
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-extending-dynamics-365-with-powerapps-2-6-2019


Finance and Operations:
Extensibility (DYN518PAL2)

We will provide an overview
and update on Microsoft's
extensibility plans. We will
discuss in detail the various
ways of extending a
solution, looking deep into
the metadata extensibility
features as well as the
ability to augment and
extend code, including via
the powerful Chain of
Command feature.

Free recording of a web
conference

50 minutes

Visual Studio Team Services
(VSTS) Setup (VIR782PAL)

This Tech Talk will walk thru
the necessary steps to
configure a VSTS instance
and project to connect to
LCS implementation project
for Dev/Test environment
configuration.

Free recording of a web
conference

41 minutes

Dataverse Data Integrator
(DYN451PAL2)

Please join us for this tech
talk on the capabilities of
Microsoft Dataverse Data
Integrator. We will discuss
integration options
between Dynamics 365
Customer Engagement and
Dynamics 365 Finance and
Operations, as well as
integrating with other,
third-party solutions.

Free recording of a web
conference

61 minutes

Integration Between
Dynamics 365 for Sales and
Dynamics 365 for Finance
& Operations via Dataverse
(DYN340PAL)

In this Tech talk we will
introduce the integration
scenario known as Prospect
to cash, with sales and
marketing activities in
Dynamics 365 for Sales and
fulfillment in Dynamics 365
for Finance and Operations.
We will also take a look at
the Data integrator and
how to modify the
integration.

Free recording of a web
conference

54 minutes

Data Management
(DYN757PAL2)

Please join us for this
TechTalk on Data
Management. Learn about
the options available and
the scenarios for which they
are recommended. We will
cover the Data
Management framework,
templates, database
copying, cross-company
data sharing, and
performance considerations.

Free recording of a web
conference

58 minutes
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https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-extensibility-10-26-18
https://community.dynamics.com/365/b/techtalks/posts/visual-studio-team-services-vsts-setup-january-17-2017
https://community.dynamics.com/365/b/techtalks/posts/cds-data-integrator-april-19-2018
https://community.dynamics.com/365/b/techtalks/posts/integration-between-dynamics-365-for-sales-and-dynamics-365-for-finance-amp-operations-via-cds-september-25-2017
https://community.dynamics.com/365/b/techtalks/posts/dynamics-365-finance-scm-data-management-february-14-2020


  

Azure Integration Tools for
Dynamics 365 for Finance
and Operations
(DYN386PAL)

This TechTalk will cover the
types of tools one might
consider while integrating
with Dynamics 365 for
Finance & Operations and
when to choose which
integration tool. The session
will also walk-through some
of integration scenarios
orchestrated using Azure
integration services.

Free recording of a web
conference

63 minutes

Integration Frameworks
within Dynamics 365 for
Finance & Operations
(DYN385PAL)

This session will provide an
overview of the integration
frameworks within
Dynamics 365 for Finance
& Operations and discuss
the consideration under
which these frameworks
could be used.

Free recording of a web
conference

64 minutes

Copy Into Legal Entity
(DYN383PAL)

In this session, we will
discuss a new feature in the
data management
framework, Copy into legal
entity. We will first briefly
review the new features
added to the data
management framework in
platform 8 for the
workspace, templates, and
data projects and then
discuss the additional
functionality added for
Copy into legal entity.

Free recording of a web
conference

54 minutes

How To Extend or Build New
Analytical Workspaces
(DYN321PAL)

This Tech Talk will provide a
walk through on how to
extend or build new
Analytical Workspaces.

Free recording of a web
conference

59 minutes

Mobile Framework
(VIR824PAL)

This tech talk will walk
through the mobile
framework capabilities for
building apps in Dynamics
365 for Operations. The
session will also
demonstrate some recently
built apps.

Free recording of a web
conference

58 minutes
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Servicing

https://community.dynamics.com/365/b/techtalks/posts/azure-integration-tools-for-dynamics-365-for-finance-and-operations-november-2-2017
https://community.dynamics.com/365/b/techtalks/posts/integration-frameworks-within-dynamics-365-for-finance-amp-operations-october-31-2017
https://community.dynamics.com/365/b/techtalks/posts/copy-into-legal-entity-october-24-2017
https://community.dynamics.com/365/b/techtalks/posts/how-to-extend-or-build-new-analytical-workspaces-september-18-2017
https://community.dynamics.com/365/b/techtalks/posts/mobile-framework-april-11-2017
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Finance and Operations:
Servicing, Supporting and
Maintaining Production
(DYN651PAL2)

Tech Talk on how to
efficiently support, maintain
and service your Dynamics
365 for Finance and
Operations production
environment.

Free recording of a web
conference

53 minutes

Finance and Operations:
Feature Management
(DYN641PAL2)

Tech Talk on the Feature
management experience. It
provides a workspace where
you can view, enable,
disable, and schedule
features that have been
delivered in each release. By
default, new features are
turned off. You can use the
workspace to turn them on
and view the
documentation for them.
Attend this meeting to see
what is delivered in 10.0.3
and our plans for future
releases.

Free recording of a web
conference

47 minutes

Finance And Operations:
Microsoft Managed
Continuous Updates
(DYN610PAL)

The Continuous Update
cadence for Finance and
Operations has started!
Please join us during this
hour to discuss Microsoft
Managed Continuous
updates, the user
experience already available
in Lifecycle Services, and
forthcoming updates.

Free recording of a web
conference

61 minutes

Microsoft Managed
Continuous Updates:
What's new (DYN543PAL2)

During this hour we will
explain what is new since
our initial announcements
about Microsoft Managed
Continuous updates. We
will discuss the cadence of
updates, how we have
responded to your valuable
feedback on the process,
and take a look at the
forthcoming Lifecycle
Services user experience,
through which you will be
able to manage your
updates.

Free recording of a web
conference

56 minutes

https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-servicing-supporting-and-maintaining-production-june-27-2019
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-microsoft-managed-continuous-updates-april-2-2019
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-microsoft-managed-continuous-updates-april-2-2019
https://community.dynamics.com/365/b/techtalks/posts/microsoft-managed-continuous-updates-what-39-s-new-12-13-18


  

  

Microsoft Managed
Continuous Updates
(DYN474PAL2)

We will discuss Microsoft’s
plans for keeping your
system up-to-date with the
latest release. We will cover
timelines, the cadence for
major and minor updates,
the planned procedures, the
implications, and what you
should do for optimal
results.

Free recording of a web
conference

62 minutes
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Migration and upgrade

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

Finance and Operations:
Upgrading from 7.x to 8+
(DYN519PAL2)

Please join us for our next
TechTalk, during which we
will cover the 7.X to 8.X
upgrade process. We will
discuss various scenarios
and steps to execute for
code upgrade and data
upgrade. We will also cover
extensibility request
scenarios and how to raise
them where appropriate.
Part 1 of 2.

Free recording of a web
conference

61 minutes

AX2012 to Dynamics 365
for Operations Upgrade
(VIR817PAL2)

This Tech Talk will provide an
overview on how to
upgrade code and data
from Dynamics AX 2012 to
Dynamics 365 for
Operations.

Free recording of a web
conference

45 minutes

AX2009 to Dynamics 365
for Operations Migration
Tools (VIR809PAL)

This session will cover
tooling available to assist
you with migrating from
AX2009 to D365 for
Operations.

Free recording of a web
conference

55 minutes

Testing
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Finance and Operations:
Acceptance Test Library
(DYN650PAL2)

Tech Talk on how to
efficiently support, maintain
and service your Dynamics
365 for Finance and
Operations production
environment.

Free recording of a web
conference

61 minutes

https://community.dynamics.com/365/b/techtalks/posts/microsoft-managed-continuous-updates-september-5-2018
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-upgrading-from-7-x-to-8-10-30-18
https://community.dynamics.com/365/b/techtalks/posts/ax2012-to-dynamics-365-for-operations-upgrade-april-20-2017
https://community.dynamics.com/365/b/techtalks/posts/ax2009-to-dynamics-365-for-operations-migration-tools-march-2-2017
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-acceptance-test-library-june-20-2019


Finance and Operations:
Regression Suite
Automation Tool --
Background & Setup
(DYN646PAL)

This is the first of a two-
part series on Regression
Suite Automation Testing
(RSAT). In this session, we
will cover how to keep pace
with continuous updates
using automated testing via
RSAT. Learnings and
recommendations on
creating task recordings
and executing tests using
RSAT will be covered, along
with a step-by-step
walkthrough of the
installation and setup.

Free recording of a web
conference

70 minutes

Finance and Operations:
Regression Suite
Automation Tool -- Testing
Lifecycle Demo
(DYN647PAL)

This is the second of a two-
part series on Regression
Suite Automation Testing
(RSAT). This session will
cover a demo of the whole
cycle of creating and saving
task recordings from
Finance and Operations to
the BPM library in LCS,
synchronizing the BPM
library to create test cases
in Azure DevOps, grouping
the test cases into test
suites, and loading and
executing the test suites in
RSAT.

Free recording of a web
conference

70 minutes

Finance and Operations:
Performance Benchmark for
Dynamics 365
(DYN550PAL2)

In this Tech Talk, we will
describe an approach for
preparing and delivering a
performance benchmark on
Microsoft Dynamics 365 for
Finance and Operations. We
will present the process,
main concepts and tools
before illustrating a simple
case with a demonstration.

Free recording of a web
conference

68 minutes

Finance and Operations:
Performance Key Patterns
and Anti-patterns for
Dynamics 365
(DYN549PAL)

In this Tech Talk, we will
present efficient
performance patterns that
we have seen project teams
implement successfully. We
will also describe anti-
patterns that can lead to
serious performance
degradation of the
Microsoft Dynamics 365 for
Finance and Operations
environment.

Free recording of a web
conference

58 minutes
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https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-regression-suite-automation-tool-background-amp-setup-may-28-2019
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-regression-suite-automation-tool-testing-lifecycle-demo-may-29-2019
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-performance-benchmark-for-dynamics-365-1-30-19
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-performance-key-patterns-and-anti-patterns-for-dynamics-365-1-15-19


  

Finance and Operations:
Performance
Troubleshooting Tools for
Dynamics 365
(DYN541PAL2)

In this Tech Talk, we will
present the different tools
that can be used to
troubleshoot Microsoft
Dynamics 365 for Finance
and Operations
performance issues. This
session will contain some
scenario-based
demonstrations and initial
guidance on how to
approach typical
performance issues.

Free recording of a web
conference

64 minutes

Task Automation
Framework for Data
Management
(DYN447PAL2)

Please join us for this tech
talk on the new Task
Automation Framework for
Data Management. Learn
how the framework
facilitates testing of data
entities & integrations,
validation of the resulting
data, and automation of
other tasks in the Data
Management Framework.

Free recording of a web
conference

55 minutes

Finance and Operations:
Warehouse App Task
Validation Framework

This talk will introduce and
explain the new Warehouse
App Task Validation
Framework, which is
designed to allow for the
automation of warehouse
tasks within the standard
Dynamics 365 Warehousing
application. This new
framework bridges the gap
between the Regression
Suite Automation Tool
(RSAT) and the warehouse
functionality so that end-
to-end regression tests can
be built, including both core
Dynamics workflows as well
as distribution scenarios
utilizing the advanced
warehousing module. The
talk will walk through the
setup and configuration of
the framework and show
how it can be utilized to
automate a warehouse
process through RSAT.

Free recording of a web
conference

66 minutes
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Exam

https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-performance-troubleshooting-tools-for-dynamics-365-12-14-18
https://community.dynamics.com/365/b/techtalks/posts/task-automation-framework-for-data-management-march-3-2018
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-warehouse-app-task-validation-framework-october-23-2019


C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT

Exam MB-500: Microsoft Dynamics
365: Finance and Operations Apps
Developer

This exam measures your ability to
accomplish the following technical
tasks: plan architecture and solution
design; apply developer tools; design
and develop AOT elements; develop
and test code; implement reporting;
integrate and manage data solutions;
and implement security and optimize
performance.

Exam, cost varies by region

NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/learn/certifications/exams/mb-500
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


  

Learning Catalog for Microsoft Partner Sales and
Marketing roles for Dynamics 365 Supply Chain
Management
2/18/2021 • 2 minutes to read • Edit Online

Get started
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Learn the business value of
Microsoft Dynamics 365
and the Power Platform

Are you interested in
learning about business
applications? Perhaps you
don’t know where to begin
with Microsoft Dynamics
365 and Power Platform
applications? Learn how the
power of business
applications can help
transform your business.

Free, self-paced online
learning path

7 hours

Dynamics 365 and Power
Platform Fundamentals

Are you interested in
learning about business
applications? Start with this
learning path to see how
Dynamics 365 apps are
used. Learn about cloud
concepts, Power Platform,
and how to get started with
Dynamics 365 apps.

Free, self-paced online
learning path

5.5 hours

Get started with Finance
and Operations apps

Learn how Finance and
Operations apps support
businesses to manage their
global financial systems,
operational business
processes, and streamlined
supply chains to empower
people to make fast,
informed decisions. As the
first step in your career of
working with Finance and
Operations apps, you must
familiarize yourself with its
features and functionality,
whatever your desired role.

Free, self-paced online
learning path

2 hours

Are you responsible for helping your customers buy the right solution?

The following catalog is organized from core knowledge to specific domains, and from most basic to most

advanced. If content exists in multiple formats, we'll let you know, so that you can choose the training format

that best meets your needs.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/get-started/learning-catalog-partner-sales.md
https://docs.microsoft.com/en-us/learn/paths/learn-business-value-of-dynamics-365-and-power-platform/
https://docs.microsoft.com/en-us/learn/paths/dyn-power-plat-bus-app-fundamentals/
https://docs.microsoft.com/en-us/learn/paths/get-started-finance-operations/


  

Course MB-900T01-A:
Dynamics 365
fundamentals

This course will familiarize
the learner with Dynamics
365 functionality and
business value. The course
will cover Dynamics 365
applications, the Power
Platform, cloud concepts,
the security model, and
licensing considerations.

Instructor-led in person or
online training; cost varies
by region and partner

1 day

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

Exam
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Dynamics 365 Fundamentals Prove that you understand Microsoft
Dynamics 365; the Power Platform;
cloud concepts; licensing options; and
deployment and release options.

Exam; cost varies by region

NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://www.microsoft.com/learning/course.aspx?cid=MB-900T01
https://docs.microsoft.com/en-us/learn/certifications/d365-fundamentals?wt.mc_id=learningredirect_certs-web-wwl
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


  

Learning Catalog for Dynamics 365 Supply Chain
Management functional consultants
2/18/2021 • 17 minutes to read • Edit Online

Get started
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Learn the business value of
Microsoft Dynamics 365
and the Power Platform

Are you interested in
learning about business
applications? Perhaps you
don’t know where to begin
with Microsoft Dynamics
365 and Power Platform
applications? Learn how the
power of business
applications can help
transform your business.

Free, self-paced online
learning path

7 hours

Dynamics 365 and Power
Platform Fundamentals

Are you interested in
learning about business
applications? Start with this
learning path to see how
Dynamics 365 apps are
used. Learn about cloud
concepts, Power Platform,
and how to get started with
Dynamics 365 apps.

Free, self-paced online
learning path

5.5 hours

Get started with Finance
and Operations apps

Learn how Finance and
Operations apps support
businesses to manage their
global financial systems,
operational business
processes, and streamlined
supply chains to empower
people to make fast,
informed decisions. As the
first step in your career of
working with Finance and
Operations apps, you must
familiarize yourself with its
features and functionality,
whatever your desired role.

Free, self-paced online
learning path

2 hours

Are you an implementation expert for a business domain?

The following catalog is organized from core knowledge to specific domains, and from most basic to most

advanced. If content exists in multiple formats, we'll let you know, so that you can choose the training format

that best meets your needs.

For functional consultants, our job-task analysis research showed that everyone must understand the core

content set as well as a domain area.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/get-started/learning-catalog-functional-consultant.md
https://docs.microsoft.com/en-us/learn/paths/learn-business-value-of-dynamics-365-and-power-platform/
https://docs.microsoft.com/en-us/learn/paths/dyn-power-plat-bus-app-fundamentals/
https://docs.microsoft.com/en-us/learn/paths/get-started-finance-operations/


  

Before you buy Check out the step-by-step
guidance whether you're
still evaluating Finance and
Operations or ready to
make a purchase.

Documentation

Release plan Find out about the latest
capabilities and
enhancements in Dynamics
365

Documentation
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Core platform knowledge
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Use Lifecycle Services to
design and plan an
implementation of Finance
and Operations apps

Lifecycle Services (LCS) is a
collaborative workspace
that customers and their
partners use to manage
Finance and Operations
apps projects from pre-
sales to the implementation
phase and finally to the
production environment. It
provides checklists and
tools that help you manage
the project, including pre-
build methodologies to help
with implementation and
regularly updated services.

Free, self-paced online
learning path

2 hours

Configure your organization
in Finance and Operations
apps

As a functional consultant
who works with Finance
and Operations apps, you
must understand how to
set up an organization for
your customer. This learning
path shows you, amongst
other tasks, how to set up
legal entities, implement
security settings,
personalize the user
interface for users, design,
and build mobile apps, and
implement common
integrations.

Free, self-paced online
learning path

12 hours

Migrate data and go live
with Finance and
Operations apps

As a functional consultant,
you must understand how
to prepare your customer's
data for migration, work
with data management, and
perform user acceptance
testing to go live with
Finance and Operations
apps.

Free, self-paced online
learning path

4 hours

https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/before-you-buy
https://docs.microsoft.com/en-us/dynamics365/release-plans/
https://docs.microsoft.com/en-us/learn/paths/use-lcs-design-plan-implementation-finance-operations/
https://docs.microsoft.com/en-us/learn/paths/configure-your-organization-finance-ops/
https://docs.microsoft.com/en-us/learn/paths/migrate-data-go-live-finance-operations/


Configure and work with
analytics and reporting in
Finance and Operations
apps

Business leaders can make
important decisions in their
company if they have
accurate insight into the
underlying financial and
operational data. A business
user can also configure, and
use the electronic reporting
tool without a single line of
code, to adopt new
regulatory requirements
and generate business
documents in the required
format to electronically
exchange information with
government bodies, banks,
and other parties.

Free, self-paced online
learning path

4 hours

Implement Finance and
Operations apps

Learn the most important
elements and the best
practices to manage a
successful Finance and
Operations implementation
project. From the first step
where you are planning and
designing your project
methodology, the use of
FastTrack services, the
development strategy, data
management and more, to
the best ways for
maintaining and monitoring
your operations after Go-
live.

Free, self-paced online
learning path

11.5 hours

Finance and Operations:
Onboarding to Dynamics
365 (DYN542PAL2)

FastTrack offers an
Onboarding service to
every Dynamics 365 for
Finance and Operations
project. In this TechTalk, we
will explain the Onboarding
process, walk through the
content of the Onboarding
session with you, and unveil
how we are making
Onboarding more efficient
and convenient in the near
future. This session is
especially relevant to
everybody who works with
customers in the early
stages of a project, between
closing the license deal and
initiation of the
implementation project.

Tech Talk (recorded webinar) 62 minutes
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https://docs.microsoft.com/en-us/learn/paths/configure-analytics-reporting-finance-operations/
https://docs.microsoft.com/en-us/learn/paths/implement-finance-operations/
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-onboarding-to-dynamics-365-1-10-19


On-Premises (Local
Business Data) Deployment
(DYN382PAL2)

Please join this tech talk for
an overview of the on-
premises deployment
option for Dynamics 365
for Finance and Operations,
Enterprise Edition. In this
session, we will look at the
solution architecture of an
on-premises deployment,
ALM aspects, system
requirements, and how to
provision the Life Cycle
Services project.

Tech Talk (recorded webinar) 48 minutes

Go-live Planning
(DYN458PAL2)

We will discuss the go-live
process in detail, and how
best to prepare for it, in
order to make it as smooth
as possible for the
customer, partner and
Microsoft.

Tech Talk (recorded webinar) 60 minutes

Environment Planning
(DYN450PAL2)

Please join us for this tech
talk on Environment
Planning. Learn about the
standard environments,
what other environments
you might need, the
options and timing for
acquiring and deploying
them, and the expected
code and data flows
between environments.

Tech Talk (recorded webinar) 53 minutes

Finance and Operations:
Feature Management
(DYN641PAL2)

Tech Talk on the Feature
management experience. It
provides a workspace where
you can view, enable,
disable, and schedule
features that have been
delivered in each release. By
default, new features are
turned off. You can use the
workspace to turn them on
and view the
documentation for them.
Attend this meeting to see
what is delivered in 10.0.3
and our plans for future
releases.

Tech Talk (recorded webinar) 47 minutes
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https://community.dynamics.com/365/b/techtalks/posts/on-premises-local-business-data-deployment-october-19-2017
https://community.dynamics.com/365/b/techtalks/posts/go-live-planning-8-9-18
https://community.dynamics.com/365/b/techtalks/posts/environment-planning-may-23-2018
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-feature-management-may-17-2019


Finance And Operations:
Microsoft Managed
Continuous Updates
(DYN610PAL)

The Continuous Update
cadence for Finance and
Operations has started!
Please join us during this
hour to discuss Microsoft
Managed Continuous
updates, the user
experience already available
in Lifecycle Services, and
forthcoming updates.

Tech Talk (recorded webinar) 61 minutes

Microsoft Managed
Continuous Updates:
What's new (DYN543PAL2)

During this hour we will
explain what is new since
our initial announcements
about Microsoft Managed
Continuous updates. We
will discuss the cadence of
updates, how we have
responded to your valuable
feedback on the process,
and take a look at the
forthcoming Lifecycle
Services user experience,
through which you will be
able to manage your
updates.

Tech Talk (recorded webinar) 56 minutes

Monitoring, Optimization
Advisor & Critical KBs
(DYN456PAL2)

We will discuss monitoring
capabilities and what
Microsoft monitors for you
in your production
environment, the
optimization advisor and
how it can be extended, the
“Critical X++ updates”
experience in LCS, and best
practices for the “Report
production outage” option
in LCS.

Tech Talk (recorded webinar) 40 minutes

Visual Studio Team Services
(VSTS) Setup (VIR782PAL)

This Tech Talk will walk thru
the necessary steps to
configure a VSTS instance
and project to connect to
LCS implementation project
for Dev/Test environment
configuration.

Tech Talk (recorded webinar) 41 minutes
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https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-microsoft-managed-continuous-updates-april-2-2019
https://community.dynamics.com/365/b/techtalks/posts/microsoft-managed-continuous-updates-what-39-s-new-12-13-18
https://community.dynamics.com/365/b/techtalks/posts/monitoring-optimization-advisor-amp-critical-kbs-july-13-2018
https://community.dynamics.com/365/b/techtalks/posts/visual-studio-team-services-vsts-setup-january-17-2017


Copy Into Legal Entity
(DYN383PAL)

In this session, we will
discuss a new feature in the
data management
framework, Copy into legal
entity. We will first briefly
review the new features
added to the data
management framework in
platform 8 for the
workspace, templates, and
data projects and then
discuss the additional
functionality added for
Copy into legal entity.

Tech Talk (recorded webinar) 54 minutes

Regression Suite
Automation Tool
(DYN480PAL)

We will discuss the
Regression Suite
Automation Tool. It
significantly reduces the
time and cost of user
acceptance testing, when
taking a Microsoft update,
or before applying custom
code and configurations to
your Dynamics 365 for
Finance and Operations
production environment. It
enables functional power
users to record business
tasks, using the Finance and
Operations task recorder,
and convert them into a
suite of automated tests,
without the need to write
source code.

Tech Talk (recorded webinar) 61 minutes

Finance and Operations:
Regression Suite
Automation Tool --
Background & Setup
(DYN646PAL)

This is the first of a two-
part series on Regression
Suite Automation Testing
(RSAT). In this session, we
will cover how to keep pace
with continuous updates
using automated testing via
RSAT. Learnings and
recommendations on
creating task recordings
and executing tests using
RSAT will be covered, along
with a step-by-step
walkthrough of the
installation and setup.

Tech Talk (recorded webinar) 70 minutes
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https://community.dynamics.com/365/b/techtalks/posts/copy-into-legal-entity-october-24-2017
https://community.dynamics.com/365/b/techtalks/posts/regression-suite-automation-tool-9-25-18
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-regression-suite-automation-tool-background-amp-setup-may-28-2019


Finance and Operations:
Regression Suite
Automation Tool -- Testing
Lifecycle Demo
(DYN647PAL)

This is the second of a two-
part series on Regression
Suite Automation Testing
(RSAT). This session will
cover a demo of the whole
cycle of creating and saving
task recordings from
Finance and Operations to
the BPM library in LCS,
synchronizing the BPM
library to create test cases
in Azure DevOps, grouping
the test cases into test
suites, and loading and
executing the test suites in
RSAT.

Tech Talk (recorded webinar) 70 minutes

Performance Testing
Approach (DYN449PAL2)

Please join us for this tech
talk on how to approach
Performance Testing. Learn
about the fundamentals,
best practices for testing,
available tools and
techniques for executing
tests and measuring
performance, and how to
use the results for
optimization.

Tech Talk (recorded webinar) 45 minutes

How to upgrade to 7.2 (July
2017) from 7.0 (RTW)/7.1
(Release 1611)
(DYN338PAL2)

In this session we will
explain how to upgrade
from Dynamics 365 Finance
and Operations application
v7.0 (RTW) and v7.1 (1611)
to v7.2 (July 2017). We
make a clear differentiation
between Live customers
and ongoing projects (not
live yet).

Tech Talk (recorded webinar) 58 minutes

Finance and Operations:
Upgrading from 7.x to 8+
(DYN519PAL2)

Please join us for our next
TechTalk, during which we
will cover the 7.X to 8.X
upgrade process. We will
discuss various scenarios
and steps to execute for
code upgrade and data
upgrade. We will also cover
extensibility request
scenarios and how to raise
them where appropriate.
Part 1 of 2.

Tech Talk (recorded webinar) 61 minutes

AX2012 to Dynamics 365
for Operations Upgrade
(VIR817PAL2)

This Tech Talk will provide an
overview on how to
upgrade code and data
from Dynamics AX 2012 to
Dynamics 365 for
Operations.

Tech Talk (recorded webinar) 45 minutes
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https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-regression-suite-automation-tool-testing-lifecycle-demo-may-29-2019
https://community.dynamics.com/365/b/techtalks/posts/performance-testing-approach-april-30-2018
https://community.dynamics.com/365/b/techtalks/posts/how-to-upgrade-to-7-2-july-2017-from-7-0-rtw-7-1-release-1611-august-3-2017
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-upgrading-from-7-x-to-8-10-30-18
https://community.dynamics.com/365/b/techtalks/posts/ax2012-to-dynamics-365-for-operations-upgrade-april-20-2017


  

Analytics & Reporting
Options: Printing and the
Document Routing Agent

This session will discuss
various printing scenarios in
D365 for Operations,
including tips and tricks for
Document Routing Agent.

Tech Talk (recorded webinar) 60 minutes

Course MB-300T01-A: Core
common features of
Dynamics 365 for Finance
and Operations

This course discusses core
common features of
Microsoft Dynamics 365 for
Finance and Operations.

Instructor-led in person or
online training, cost varies
by region and partner

1 day

Course MB-300T02-A: Core
configuration in Dynamics
365 for Finance and
Operations

This course discusses core
configuration tasks for
Microsoft Dynamics 365 for
Finance and Operations.

Instructor-led in person or
online training, cost varies
by region and partner

1 day

Course MB-300T03-A: Data
migration and preparing for
go-live with Dynamics 365
for Finance and Operations

This course discusses data
migration and go-live
preparation for Microsoft
Dynamics 365 for Finance
and Operations.

Instructor-led in person or
online training, cost varies
by region and partner

1 day

Implementation Lifecycle
home page

These topics describe the
programs, tools, and
processes available related
to the implementation
lifecycle of your Microsoft
Dynamics 365 for Finance
and Operations project.

Documentation
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Manufacturing
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Configure and use discrete
manufacturing in Dynamics
365 Supply Chain
Management

If a company only produces
simple products, production
can be scheduled manually
with the correct bill of
materials (BOM) parts
arriving on the production
floor, at the correct time,
and at the proper resource.
As a functional consultant
for manufacturing, you
need to know how to
configure Dynamics 365
Supply Chain Management
for discrete manufacturing,
so your customer can
perform and control the
production lifecycle.

Free, self-paced online
learning path

16.5 hours

https://community.dynamics.com/365/b/techtalks/posts/analytics-amp-reporting-options-printing-and-the-document-routing-agent-february-8-2018
https://www.microsoft.com/learning/course.aspx?cid=MB-300T01
https://www.microsoft.com/learning/course.aspx?cid=MB-300T02
https://www.microsoft.com/learning/course.aspx?cid=MB-300T03
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/imp-lifecycle/implementation-lifecycle
https://docs.microsoft.com/en-us/learn/paths/configure-use-discrete-manufacturing-dyn365-supply-chain-mgmt/


Configure and use lean
manufacturing in Dynamics
365 Supply Chain
Management

Lean manufacturing is a
journey of continuous
improvement. The goal is to
produce exactly what the
customer wants, when the
customer wants it, and to
do it economically. You can
use lean manufacturing in a
unified (mixed-mode)
manufacturing environment
that combines various
supply, production, and
sourcing strategies. These
strategies include
production orders, batch
orders for process
industries, purchase orders,
and transfer orders. The
lean manufacturing
architecture in Dynamics
365 Supply Chain
Management consists of
production flows, activities,
and Kanban rules.

Free, self-paced online
learning path

12.5 hours

Configure and use process
manufacturing in Dynamics
365 Supply Chain
Management

Process manufacturing is
associated with formulas
and manufacturing recipes,
in contrast with discrete
manufacturing, which uses
discrete units, and bills of
materials. Process
manufacturing is used in
manufacturing
environments where
production is completed in
batch or semi-continuous
processes.

Free, self-paced online
learning path

10.5 hours

Master planning in
Dynamics 365 Supply Chain
Management

Master planning allows
companies to identify and
balance the raw materials
and capacity required to
meet their future goals.
Master planning assesses
which raw materials and
capacities are currently
available, and which raw
materials and capacities are
required to complete
production. For example, it
identifies what must be
manufactured, purchased,
transferred, or set aside as
safety stock before you can
complete production.

Free, self-paced online
learning path

5 hours
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https://docs.microsoft.com/en-us/learn/paths/configure-use-lean-manufacturing-dyn365-supply-chain-mgmt/
https://docs.microsoft.com/en-us/learn/paths/configure-use-process-manufacturing-dyn365-supply-chain-mgmt/
https://docs.microsoft.com/en-us/learn/paths/master-planning-supply-chain-management/


  

Use warehouse
management in
manufacturing in Dynamics
365 Supply Chain
Management

Using warehouse
management in
manufacturing processes in
Dynamics 365 Supply Chain
Management helps
optimize and streamline
warehouse processes in
your manufacturing
environment, according to
your company's needs.

Free, self-paced online
learning path

10.5 hours

Course MB-320T01-A:
Configure and use discrete
manufacturing in Dynamics
365 for Finance and
Operations

This course discusses how
to configure and use
discrete manufacturing in
Dynamics 365 for Finance
and Operations.

Instructor-led in person or
online training, cost varies
by region and partner

2 days

Course MB-320T02-A:
Configure and use lean
manufacturing in Dynamics
365 for Finance and
Operations

This course discusses how
to configure and use lean
manufacturing in Dynamics
365 for Finance and
Operations.

Instructor-led in person or
online training, cost varies
by region and partner

1 day

Course MB-320T03-A:
Configure and use process
manufacturing in Dynamics
365 for Finance and
Operations

This course discusses how
to configure and use
process manufacturing in
Dynamics 365 for Finance
and Operations.

Instructor-led in person or
online training, cost varies
by region and partner

1 day

Microsoft Certified:
Dynamics 365 for Finance
and Operations,
Manufacturing Functional
Consultant Associate

Microsoft Certified:
Dynamics 365 for Finance
and Operations,
Manufacturing Functional
Consultants integrate
digital and physical systems;
improve visibility,
manufacturing efficiency
and flexibility; and lower
costs for their clients.

Certification, cost varies by
region
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Supply chain management
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https://docs.microsoft.com/en-us/learn/paths/use-warehouse-manufacturing-dyn365-supply-chain-mgmt/
https://www.microsoft.com/learning/course.aspx?cid=MB-320T01
https://www.microsoft.com/learning/course.aspx?cid=MB-320T02
https://www.microsoft.com/learning/course.aspx?cid=MB-320T03
https://www.microsoft.com/learning/d365-functional-consultant-manufacturing.aspx


Configure and manage
products and inventory in
Dynamics 365 Supply Chain
Management

Product information is the
pillar of supply chain and
retail applications across all
industries. In the various
modules of a business
solution, product-specific
information and
configuration are required
to manage the business
processes that are related
to products, product
families, bills of materials,
and product categories.
Inventory reports show you
in a variety of ways how
much inventory you have
and explain how to be more
effective in your inventory
investments. Master
planning helps you
streamline your planning
based on predetermined
factors, so you can
efficiently plan what
materials need to be
purchased, transferred, or
manufactured.

Free, self-paced online
learning path

14 hours

Configure and manage
procurement and vendors
in Dynamics 365 Supply
Chain Management

The process of finding and
working with vendors,
purchasing products, and
ensuring the quality of
goods and services are all
important factors that
impact a company's
reputation and success.

Free, self-paced online
learning path

14 hours

Configure and manage
sales, and customers in
Dynamics 365 Supply Chain
Management

The process of working with
customers, understanding
the life cycle of the sales
process, and setting up
sales agreements are all
important factors that
impact a company's success.

Free, self-paced online
learning path

7 hours
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https://docs.microsoft.com/en-us/learn/paths/configure-manage-products-inventory-dyn365-supply-chain-mgmt/
https://docs.microsoft.com/en-us/learn/paths/configure-manage-procurement-vendors-dyn365-supply-chain-mgmt/
https://docs.microsoft.com/en-us/learn/paths/configure-manage-sales-customers-dyn365-supply-chain-mgmt/


Master planning in
Dynamics 365 Supply Chain
Management

Master planning allows
companies to identify and
balance the raw materials
and capacity required to
meet their future goals.
Master planning assesses
which raw materials and
capacities are currently
available, and which raw
materials and capacities are
required to complete
production. For example, it
identifies what must be
manufactured, purchased,
transferred, or set aside as
safety stock before you can
complete production.

Free, self-paced online
learning path

5 hours

Configure and work with
warehouse management in
Dynamics 365 for Finance
and Operations

Warehouse management in
Dynamics 365 Supply Chain
Management helps
optimize and streamline
warehouse processes
according to your individual
needs and provides the
insight into your inventory
and the tools to help
increase customer
satisfaction and reduce
costs.

Free, self-paced online
learning path

8.5 hours

Configure and work with
transportation
management in Dynamics
365 Supply Chain
Management

The Transportation
management module in
Dynamics 365 Supply Chain
Management helps you find
the most efficient way to
deliver goods to your
customers. Transportation
management calculates the
least expensive and fastest
way of delivering goods and
lets you identify vendor and
routing solutions for
inbound and outbound
orders.

Free, self-paced online
learning path

3 hours
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https://docs.microsoft.com/en-us/learn/paths/master-planning-supply-chain-management/
https://docs.microsoft.com/en-us/learn/paths/configure-work-warehouse-management-dyn365-supply-chain-mgmt/
https://docs.microsoft.com/en-us/learn/paths/configure-work-transportation-mgmt-dyn365-supply-chain-mgmt/


Warehousing Mobile App
(VIR816PAL)

This Tech Talk will discuss
the Advanced Warehousing
system in Dynamics 365 for
Operations and what the
future holds for the
advanced warehousing
mobile interface. We will
examine the new mobile
application that has been
released and how it
compares to the legacy
WMDP. We will learn what is
required to install,
configure, and operate this
mobile application and how
it can be used to benefit
your implementations.

Free recording of a web
conference

54 minutes

Vendor Collaboration
(DYN327PAL)

This Tech Talk will provide a
walk through on the
Vendor Collaboration
feature including the
Consumption of Response
from Vendor feature that is
included in the July (spring)
release.

Free recording of a web
conference

58 minutes

Item And Warehouse
Migration Process To Use
Advanced Warehouse
Management (DYN316PAL)

In this Tech Talk, we will
teach you how to migrate
existing warehouse setup
and items with open
transactions to the advance
warehouse management,
by using the new
capabilities to change the
storage dimension group
for items and enable
warehouses to use the
advanced warehouse
management processes.

Free recording of a web
conference

54 minutes

Supply chain management
home page

This topic provides a list of
the help topics and other
resources for the supply
chain management features
in Microsoft Dynamics 365
for Finance and Operations.

Documentation

Demand Replenishment for
Raw Material Picking
(DYN333PAL2)

This TechTalk will cover raw
material picking and
demand replenishment for
raw material picking.

Free recording of a web
conference

38 minutes

Course MB-330T01-A:
Configure and use supply
chain management in
Dynamics 365 for Finance
and Operations

This course discusses how
to configure and use supply
chain management in
Dynamics 365 for Finance
and Operations.

Instructor-led in person or
online training, cost varies
by region and partner

2 days

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

https://community.dynamics.com/365/b/techtalks/posts/warehousing-mobile-app-march-22-2017
https://community.dynamics.com/365/b/techtalks/posts/vendor-collaboration-july-25-2017
https://community.dynamics.com/365/b/techtalks/posts/item-and-warehouse-migration-process-to-use-advanced-warehouse-management-june-27-2017
https://docs.microsoft.com/en-us/dynamics365/unified-operations/supply-chain/
https://community.dynamics.com/365/b/techtalks/posts/demand-replenishment-for-raw-material-picking-september-28-2017
https://www.microsoft.com/learning/course.aspx?cid=MB-330T01


  

Course MB-330T02-A: Use
quality management,
Intercompany trading and
master planning in
Dynamics 365 for Finance
and Operations

This course discusses how
to use quality management,
intercompany trading and
master planning in
Dynamics 365 for Finance
and Operations.

Instructor-led in person or
online training, cost varies
by region and partner

1 day

Course MB-330T03-A:
Configure and use
warehouse, and
transportation
management in Dynamics
365 for Finance and
Operations

This course discusses how
to configure and use
warehouse and
transportation
management in Dynamics
365 for Finance and
Operations.

Instructor-led in person or
online training, cost varies
by region and partner

1 day

Configure Asset
Management for Dynamics
365 Supply Chain
Management

Asset Management is an
add-in for Dynamics 365
Supply Chain Management,
that is used to manage
assets that are used in the
daily operation of your
company. Some examples of
these types of assets are
machinery, production
equipment, and fork lifts.

Free, self-paced online
learning path

7 hours

Work with Asset
Management for Dynamics
365 Supply Chain
Management

Asset Management is an
add-in to Dynamics 365
Supply Chain Management,
that is used to manage
assets that are used in the
daily operation of your
company. Some examples of
these types of assets are
machinery, production
equipment, and fork lifts.

Free, self-paced online
learning path

12.5 hours

Microsoft Certified:
Dynamics 365 for Finance
and Operations, Supply
Chain Management
Functional Consultant
Associate

Microsoft Certified:
Dynamics 365 for Finance
and Operations, Supply
Chain Management
Functional Consultants
streamline cost accounting,
inventory management,
master planning, and
warehouse management for
their clients.

Certification, cost varies by
region
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Exams
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https://www.microsoft.com/learning/course.aspx?cid=MB-330T02
https://www.microsoft.com/learning/course.aspx?cid=MB-330T03
https://docs.microsoft.com/en-us/learn/paths/configure-asset-management-dyn365-supply-chain-mgmt/
https://docs.microsoft.com/en-us/learn/paths/work-asset-management-dyn365-supply-chain-mgmt/
https://www.microsoft.com/learning/d365-functional-consultant-supply-chain-management.aspx


Exam MB-300: Microsoft Dynamics
365 Unified Operations Core

This exam measures your ability to
accomplish the following technical
tasks: use common functionality and
implementation tools; configure
security, processes, and options;
perform data migration; and validate
and support the solution.

Exam, cost varies by region

Exam MB-330: Microsoft Dynamics
365 for Finance and Operations,
Supply Chain Management

This exam measures your ability to
accomplish the following technical
tasks: implement product information
management; implement inventory
management; implement and manage
supply chain processes; and implement
warehouse management and
transportation management and
perform business processes.

Exam, cost varies by region

Exam MB-320: Microsoft Dynamics
365 for Finance and Operations,
Manufacturing

This exam measures your ability to
accomplish the following technical
tasks: set up and configure
manufacturing; create and manage
production and lean orders; and
create, process, and manage
production batch orders.

Exam, cost varies by region
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NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/learn/certifications/exams/mb-300?wt.mc_id=learningredirect_certs-web-wwl
https://docs.microsoft.com/en-us/learn/certifications/exams/mb-330?wt.mc_id=learningredirect_certs-web-wwl
https://www.microsoft.com/learning/exam-MB-320.aspx
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


  

Learning catalog for Dynamics 365 Supply Chain
Management solution architects
2/18/2021 • 12 minutes to read • Edit Online

NOTENOTE

Get started
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Dynamics FastTrack
Architect Bootcamp

The Dynamics FastTrack
Architect Bootcamps are
EXCLUSIVELY for solution
integrator partners
commencing customer
implementations that are
governed by the Microsoft
Dynamics 365 FastTrack
customer success program.
The FREE intensive
Bootcamps are
SPECIFICALLY for solution
integrator partner
architects assigned to
FastTrack engagements and
are led by senior architects
from the Dynamics 365
engineering team.

Free instructor-led in-
person training.
Qualifications apply.

5 days

Effective November 2020:

Common Data Service has been renamed to Microsoft Dataverse. For more information, see Power Automate Blog.

Some terminology in Microsoft Dataverse has been updated. For example, entity is now table and field is now column.

For more information, see Terminology updates.

This topic will be updated soon to reflect the latest terminology.

Do you design solutions that meet your customers' needs and budgets?

The following catalog is organized from core knowledge to specific domains, and from most basic to most

advanced. If content exists in multiple formats, we'll let you know, so that you can choose the training format

that best meets your needs.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/get-started/learning-catalog-solution-architect.md
https://aka.ms/PAuAppBlog
https://go.microsoft.com/fwlink/?linkid=2147247
https://community.dynamics.com/365/b/partnerevents/posts/dynamics-365-fasttracks-bootcamp


  

Becoming a Solution
Architect for Dynamics 365
and Power Platform

A Solution Architect is
responsible for the
successful design,
implementation,
deployment, and adoption
of an overall solution. A
Solution Architect ensures
that the solution meets the
customer’s needs now and
in the future. While the
Solution Architect may not
“click the buttons” during a
deployment, they are
ultimately responsible for
the solution and work
closely with the deployment
team.

Free, self-paced online
learning path

4 hours
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Core platform knowledge
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Implement Finance and
Operations apps

Learn the most important
elements and the best
practices to manage a
successful Finance and
Operations implementation
project. From the first step
where you are planning and
designing your project
methodology, the use of
FastTrack services, the
development strategy, data
management and more, to
the best ways for
maintaining and monitoring
your operations after Go-
live.

Free, self-paced online
learning path

11.5 hours

Go-live Planning
(DYN458PAL2)

We will discuss the go-live
process in detail, and how
best to prepare for it, in
order to make it as smooth
as possible for the
customer, partner, and
Microsoft.

Free recording of a web
conference

60 minutes

Environment Planning
(DYN450PAL2)

Join us for this tech talk on
Environment Planning.
Learn about the standard
environments, what other
environments you might
need, the options and
timing for acquiring and
deploying them, and the
expected code and data
flows between
environments.

Free recording of a web
conference

53 minutes

https://docs.microsoft.com/en-us/learn/paths/become-solution-architect/
https://docs.microsoft.com/en-us/learn/paths/implement-finance-operations/
https://community.dynamics.com/365/b/techtalks/posts/go-live-planning-8-9-18
https://community.dynamics.com/365/b/techtalks/posts/environment-planning-may-23-2018


  

Demo Data Packages
(DYN443PAL)

Join us for this tech talk on
the recently released demo
data packages. You can use
them to customize the
demo data you need for
your scenarios, and then
load just what you need
into an environment.

Free recording of a web
conference

40 minutes

On-Premises (Local
Business Data) Deployment
(DYN382PAL2)

Join this tech talk for an
overview of the on-
premises deployment
option for Dynamics 365
for Finance and Operations,
Enterprise Edition. In this
session, we will look at the
solution architecture of an
on-premises deployment,
ALM aspects, system
requirements, and how to
provision the Life Cycle
Services project.

Free recording of a web
conference

48 minutes

Reduce Data Import and
Export Time Using
Configurations
(DYN315PAL)

In this Tech Talk, we will
discuss the new
configuration feature in
Dynamics 365 for Finance
and Operations, Enterprise
edition. We will show how
you can set up
configurations using
predefined templates, copy
configuration data from a
legal entity to a data project
and export it, and then
import it into another legal
entity.

Free recording of a web
conference

52 minutes

Reporting Options in
Dynamics 365 for
Operations (VIR810PAL)

This session will discuss
various printing scenarios in
D365 for Operations,
including tips and tricks for
Document Routing Agent.

Free recording of a web
conference

60 minutes

Analytics & Reporting
Options: Printing and the
Document Routing Agent

Join us for this tech talk on
two related topics. First we
will discuss Analytics and
Reporting solution patterns
and tools for Dynamics 365
for Finance and Operations,
Enterprise Edition. Secondly,
we will discuss printing
scenarios and the
Document Routing Agent.

Free recording of a web
conference

45 minutes
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Core development concepts

https://community.dynamics.com/365/b/techtalks/posts/demo-data-packages-february-14-2018
https://community.dynamics.com/365/b/techtalks/posts/on-premises-local-business-data-deployment-october-19-2017
https://community.dynamics.com/365/b/techtalks/posts/reduce-data-import-and-export-time-using-configurations-june-13-2017
https://community.dynamics.com/365/b/techtalks/posts/reporting-options-in-dynamics-365-for-operations-february-23-2017
https://community.dynamics.com/365/b/techtalks/posts/analytics-amp-reporting-options-printing-and-the-document-routing-agent-february-8-2018
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Finance and Operations:
Acceptance Test Library
(DYN650PAL2)

Microsoft recently made the
Acceptance Test Library
(ATL) publicly available. ATL
is a library of around 5,000
classes that helps you
author readable,
performant, quality X++
tests and consistent test
data, while hiding the
complexity of setting up
prerequisites. These are the
same classes Microsoft uses
internally for testing. The
ATL framework’s fluent API
facilitates the Test Driven
Development and
Specification By Example
software engineering
approaches. Join us for this
Tech Talk to learn more
about it.

Free recording of a web
conference

61 minutes

Finance and Operations:
Extending Dynamics 365 for
Finance and Operations
with PowerApps
(DYN558PAL2)

Tech Talk that discusses in
detail and demonstrates
extending talent
applications using Microsoft
PowerApps and Flow.

Free recording of a web
conference

43 minutes

Data Management
(DYN757PAL2)

Join us for this TechTalk on
Data Management. Learn
about the options available
and the scenarios for which
they are recommended. We
will cover the Data
Management framework,
templates, database
copying, cross-company
data sharing, and
performance considerations.

Free recording of a web
conference

58 minutes

Azure Integration Tools for
Dynamics 365 for Finance
and Operations
(DYN386PAL)

This TechTalk will cover the
types of tools one might
consider while integrating
with Dynamics 365 for
Finance & Operations and
when to choose which
integration tool. The session
will also walk through some
of integration scenarios
orchestrated using Azure
integration services.

Free recording of a web
conference

63 minutes

https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-acceptance-test-library-june-20-2019
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-extending-dynamics-365-with-powerapps-2-6-2019
https://community.dynamics.com/365/b/techtalks/posts/dynamics-365-finance-scm-data-management-february-14-2020
https://community.dynamics.com/365/b/techtalks/posts/azure-integration-tools-for-dynamics-365-for-finance-and-operations-november-2-2017


Extensibility (DYN384PAL2) This session will provide an
overview of the extensibility
plans Microsoft has
announced and the
recommended path forward
for partners and customers
who have overlayered code.
We will discuss the various
methods of extending a
solution, looking deep into
the metadata extensibility
features as well as the
ability to augment and
extend code. The powerful
new Chain of Command
feature will be
demonstrated, and we will
show how many
extensibility features are
unblocked by this
technology.

Free recording of a web
conference

55 minutes

Integration Frameworks
within Dynamics 365 for
Finance & Operations
(DYN385PAL)

This session will provide an
overview of the integration
frameworks within
Dynamics 365 for Finance
& Operations and discuss
the consideration under
which these frameworks
could be used.

Free recording of a web
conference

64 minutes

Integration Between
Dynamics 365 for Sales and
Dynamics 365 for Finance
& Operations via Dataverse
(DYN340PAL)

In this Tech talk we will
introduce the integration
scenario known as Prospect
to cash, with sales and
marketing activities in
Dynamics 365 for Sales and
fulfillment in Dynamics 365
for Finance and Operations.
We will also take a look at
the Data integrator and
how to modify the
integration.

Free recording of a web
conference

54 minutes

Mobile Framework
(VIR824PAL)

This tech talk will walk
through the mobile
framework capabilities for
building apps in Dynamics
365 for Operations. The
session will also
demonstrate some recently
built apps.

Free recording of a web
conference

58 minutes

Integration (VIR806PAL) This Tech Talk will discuss
different integration options
for Dynamics 365 for
Operations including code
samples and
demonstrations.

Free recording of a web
conference

58 minutes
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https://community.dynamics.com/365/b/techtalks/posts/extensibility-november-1-2017
https://community.dynamics.com/365/b/techtalks/posts/integration-frameworks-within-dynamics-365-for-finance-amp-operations-october-31-2017
https://community.dynamics.com/365/b/techtalks/posts/integration-between-dynamics-365-for-sales-and-dynamics-365-for-finance-amp-operations-via-cds-september-25-2017
https://community.dynamics.com/365/b/techtalks/posts/mobile-framework-april-11-2017
https://community.dynamics.com/365/b/techtalks/posts/integration-february-16-2017


  

Visual Studio Team Services
(VSTS) Setup (VIR782PAL)

This Tech Talk will walk
through the necessary
steps to configure a VSTS
instance and project to
connect to LCS
implementation project for
Dev/Test environment
configuration.

Free recording of a web
conference

41 minutes
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Migration and upgrade
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Updates and upgrades for
Finance and Operations
apps

The world of enterprise
resource planning (ERP) is
continuously evolving and
helping customers scale up
in productivity and
streamline their operations.
The evolution of Finance
and Operations encourages
customers to upgrade their
previous Microsoft
Dynamics AX versions to
the Finance and Operations
cloud service.

Free, self-paced online
learning module

1 hour

Finance and Operations:
Upgrading from 7.x to 8+
(DYN519PAL2)

Join us for our next
TechTalk, during which we
will cover the 7.X to 8.X
upgrade process. We will
discuss various scenarios
and steps to execute for
code upgrade and data
upgrade. We will also cover
extensibility request
scenarios and how to raise
them where appropriate.
Part 1 of 2.

Free recording of a web
conference

61 minutes

How to upgrade to 7.2 (July
2017) from 7.0 (RTW)/7.1
(Release 1611)
(DYN338PAL2)

In this session, we will
explain how to upgrade
from Dynamics 365 Finance
and Operations application
v7.0 (RTW) and v7.1 (1611)
to v7.2 (July 2017). We
make a clear differentiation
between Live customers
and ongoing projects (not
live yet).

Free recording of a web
conference

44 minutes

AX2012 to Dynamics 365
for Operations Upgrade
(VIR817PAL2)

This Tech Talk will provide an
overview on how to
upgrade code and data
from Dynamics AX 2012 to
Dynamics 365 for
Operations.

Free recording of a web
conference

45 minutes

https://community.dynamics.com/365/b/techtalks/posts/visual-studio-team-services-vsts-setup-january-17-2017
https://docs.microsoft.com/en-us/learn/modules/upgrades-updates-finance-operations-apps/
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-upgrading-from-7-x-to-8-10-30-18
https://community.dynamics.com/365/b/techtalks/posts/how-to-upgrade-to-7-2-july-2017-from-7-0-rtw-7-1-release-1611-august-3-2017
https://community.dynamics.com/365/b/techtalks/posts/ax2012-to-dynamics-365-for-operations-upgrade-april-20-2017


  

AX2009 Migration Tool This Tech Talk will cover the
installation, configuration,
estimation, migration
methodology, and
customization aspects of
AX2009 Data Migration
Tool.

Free recording of a web
conference

57 minutes
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Servicing
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Finance and Operations:
Servicing, Supporting and
Maintaining Production
(DYN651PAL2)

Tech Talk on how to
efficiently support,
maintain, and service your
Dynamics 365 for Finance
and Operations production
environment

Free recording of a web
conference

53 minutes

Finance and Operations:
Feature Management
(DYN641PAL2)

Tech Talk on the Feature
management experience. It
provides a workspace where
you can view, enable,
disable, and schedule
features that have been
delivered in each release. By
default, new features are
turned off. You can use the
workspace to turn them on
and view the
documentation for them.
Attend this meeting to see
what is delivered in 10.0.3
and our plans for future
releases.

Free recording of a web
conference

47 minutes

Finance And Operations:
Microsoft Managed
Continuous Updates
(DYN610PAL)

The Continuous Update
cadence for Finance and
Operations has started!
Join us during this hour to
discuss Microsoft Managed
Continuous updates, the
user experience already
available in Lifecycle
Services, and forthcoming
updates.

Free recording of a web
conference

61 minutes

Finance And Operations:
Microsoft Managed
Continuous Updates:
What's new - November 1,
2018 (DYN533cust)

During this hour, we will
discuss updates to the
Microsoft Managed
Continuous update cadence
as well as take a look at the
user experience in Lifecycle
Services.

Free recording of a web
conference

59 minutes

https://community.dynamics.com/365/b/techtalks/posts/ax2009-migration-tool-may-11-2017
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-servicing-supporting-and-maintaining-production-june-27-2019
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-feature-management-may-17-2019
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-microsoft-managed-continuous-updates-april-2-2019
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-microsoft-managed-continuous-updates-what-39-s-new-november-1-2018


  

Microsoft Managed
Continuous Updates:
What's new (DYN543PAL2)

During this hour, we will
explain what is new since
our initial announcements
about Microsoft Managed
Continuous updates. We
will discuss the cadence of
updates, how we have
responded to your valuable
feedback on the process,
and take a look at the
forthcoming Lifecycle
Services user experience,
through which you will be
able to manage your
updates.

Free recording of a web
conference

56 minutes

Microsoft Managed
Continuous Updates
(DYN474PAL2)

We will discuss Microsoft’s
plans for keeping your
system up to date with the
latest release. We will cover
timelines, the cadence for
major and minor updates,
the planned procedures, the
implications, and what you
should do for optimal
results.

Free recording of a web
conference

62 minutes

Monitoring, Optimization
Advisor & Critical KBs
(DYN456PAL2)

We will discuss monitoring
capabilities and what
Microsoft monitors for you
in your production
environment, the
optimization advisor and
how it can be extended, the
“Critical X++ updates”
experience in LCS, and best
practices for the “Report
production outage” option
in LCS.

Free recording of a web
conference

40 minutes

Microsoft Managed
Continuous Updates
(DYN474PAL2)

This Tech Talk will provide a
walk-through on punch out
functionality and will cover
the setup of an external
catalog via purchase
requisition scenario.

Free recording of a web
conference

42 minutes
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Testing
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https://community.dynamics.com/365/b/techtalks/posts/microsoft-managed-continuous-updates-what-39-s-new-12-13-18
https://community.dynamics.com/365/b/techtalks/posts/microsoft-managed-continuous-updates-september-5-2018
https://community.dynamics.com/365/b/techtalks/posts/monitoring-optimization-advisor-amp-critical-kbs-july-13-2018
https://community.dynamics.com/365/b/techtalks/posts/microsoft-managed-continuous-updates-september-5-2018


Microsoft Managed
Continuous Updates
(DYN474PAL2)

After all customer
requirements have been
handled by either
configuration,
customization, and
integration, you need to
know how to perform user
acceptance testing (UAT) in
Finance and Operations
apps to validate the
solution. User acceptance
testing is an important step
in the go-live preparation.

Free, self-paced online
learning module

1 hour

Finance and Operations:
Regression Suite
Automation Tool -
Background & Setup
(DYN646PAL)

This is the first of a two-
part series on Regression
Suite Automation Testing
(RSAT). In this session, we
will cover how to keep pace
with continuous updates
using automated testing via
RSAT. Learnings and
recommendations on
creating task recordings
and executing tests using
RSAT will be covered, along
with a step-by-step
walkthrough of the
installation and setup.

Free recording of a web
conference

70 minutes

Finance and Operations:
Regression Suite
Automation Tool - Testing
Lifecycle Demo
(DYN647PAL)

This is the second of a two-
part series on Regression
Suite Automation Testing
(RSAT). This session will
cover a demo of the whole
cycle of creating and saving
task recordings from
Finance and Operations to
the BPM library in LCS,
synchronizing the BPM
library to create test cases
in Azure DevOps, grouping
the test cases into test
suites, and loading and
executing the test suites in
RSAT.

Free recording of a web
conference

70 minutes

Finance and Operations:
Performance Benchmark for
Dynamics 365
(DYN550PAL2)

In this Tech Talk, we will
describe an approach for
preparing and delivering a
performance benchmark on
Microsoft Dynamics 365 for
Finance and Operations. We
will present the process,
main concepts, and tools
before illustrating a simple
case with a demonstration.

Free recording of a web
conference

68 minutes
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https://community.dynamics.com/365/b/techtalks/posts/microsoft-managed-continuous-updates-september-5-2018
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-regression-suite-automation-tool-testing-lifecycle-demo-may-29-2019
https://infopedia.eventbuilder.com/event?eventid=r5j6c1&source=Dynamics_365_for_Operations_-_FastTrack_Tech_Talks
https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-performance-benchmark-for-dynamics-365-1-30-19


  

Finance and Operations:
Performance Key Patterns
and Anti-patterns for
Dynamics 365
(DYN549PAL)

In this Tech Talk, we will
present efficient
performance patterns that
we have seen project teams
implement successfully. We
will also describe anti-
patterns that can lead to
serious performance
degradation of the
Microsoft Dynamics 365 for
Finance and Operations
environment.

Free recording of a web
conference

58 minutes

Regression Suite
Automation Tool
(DYN480PAL)

We will discuss the
Regression Suite
Automation Tool. It
significantly reduces the
time and cost of user
acceptance testing, when
taking a Microsoft update,
or before applying custom
code and configurations to
your Dynamics 365 for
Finance and Operations
production environment. It
enables functional power
users to record business
tasks, using the Finance and
Operations task recorder,
and convert them into a
suite of automated tests,
without the need to write
source code.

Free recording of a web
conference

61 minutes

Performance Testing
Approach (DYN449PAL2)

Join us for this tech talk on
how to approach
Performance Testing. Learn
about the fundamentals,
best practices for testing,
available tools, and
techniques for executing
tests and measuring
performance, and how to
use the results for
optimization.

Free recording of a web
conference

45 minutes

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT L EN GT HL EN GT H

Exam

C O N T EN TC O N T EN T DESC RIP T IO NDESC RIP T IO N F O RM ATF O RM AT

Exam MB-700: Microsoft Dynamics
365: Finance and Operations Apps
Solution Architect

This exam measures your ability to
accomplish the following technical
tasks: identify solution requirements;
design solution components; and
define solution testing and
management strategies.

Exam, cost varies by region

https://community.dynamics.com/365/b/techtalks/posts/finance-and-operations-performance-key-patterns-and-anti-patterns-for-dynamics-365-1-15-19
https://community.dynamics.com/365/b/techtalks/posts/regression-suite-automation-tool-9-25-18
https://community.dynamics.com/365/b/techtalks/posts/performance-testing-approach-april-30-2018
https://docs.microsoft.com/en-us/learn/certifications/exams/mb-700


NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


User interface elements
2/18/2021 • 3 minutes to read • Edit Online

Overview

Tabs, fields, and sections

This topic describes the user interface (UI) elements used in the app. Before users can navigate the interface, it's

important to know the names and functions of the elements that make up the interface.

Action PaneAction Pane - The bar beneath the navigation bar. Here, you can select tabs to change records shown in the

page. You can edit and save the records here.

FactBoxFactBox - You can see information and follow the activities of certain records in this pane.

FactBox paneFactBox pane Here, you can scroll through different aspects of a record to view in the FactBox.

Filter  paneFilter  pane - On some pages, you can select Show filtersShow filters  to open this pane. It allows you to narrow the

results visible to you on the page.

Navigation barNavigation bar  - The bar at the top of the interface. It contains the Dynamics 365 por talDynamics 365 por tal , SearchSearch,

company pickercompany picker , Action centerAction center , SettingsSettings , Help & Suppor tHelp & Suppor t, and the user profile.

Navigation listNavigation list - On some pages, you can scroll through this pane to find a specific record. When selected,

the details of the record will appear in the page.

Navigation paneNavigation pane - The left-most pane. From here, you can find any page in the product.

PagePage - The central focus of the interface. Selections made on the other UI components will affect what

records are shown here.

PanePane - The right-most pane. This will open in some cases when aspects of a record need to be changed and

saved.

TabTab - When referring to the Action Pane, it's a menu of options that appears when you select a given option

in the Action Pane.

A tab is a selection made on the page that opens a different aspect of a record on the same page. Often, it will

allow you to change certain fields, or UI elements that allow typed input.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/user-interface-elements.md


Dialog boxes and drop-down menus

A FastTab is a tab with the added benefit of allowing multiple tabs to be visible at the same. You can expand a

FastTab by selecting the downward-pointing arrow on the right end of it.

A section is similar to a tab. The word "section" is often used to describe any area of a page that organizes a

specific category of information. In the following image, Summary, Orders and favorites, and Links are all

examples of sections.

A dialog box is a pane that opens when certain selections are made to change or create a record. Dialog boxes

contain fields that allow you to enter typed input. Sometimes, a given field will allow you to select a downward

facing arrow that opens a list of options to choose from. This is called a drop-down menu. In the following

image, the TypeType and Customer groupCustomer group fields contain the option to open a drop-down menu.



 Notifications

In some cases, a dialog box will open near a given button when you select it. This is called a drop-down dialog

box. In the following image, the As of dateAs of date button was selected, which opened a drop-down dialog box.

Certain changes to the objects you oversee will appear as notifications. Notifications may notify you when a

specific customer's information has been changed, or it may alert you when the system can't accept inputs

you've added in certain fields. You can learn how to customize what you receive notifications about in the Alerts

overview.

Notifications appear in a variety of ways.

Feature calloutFeature callout - This will appear next to a field, tab, or other button to offer an explanation of what the

feature is used for.

Action centerAction center  - A box that contains the notification will appear next to the Action center button on the

navigation bar. You can see details about the notification by selecting Action centerAction center .

Message barMessage bar  - This will appear beneath the Action Pane.



Toolbars, grids, and lists

The following image shows examples of these types of notifications.

Message boxMessage box - This will appear over the interface and must be interacted with before you can continue to

use the product.

A toolbar contains tools, such as the ability to add fields or remove records. Sometimes, a toolbar will appear on

the page above a grid. This area, grid, is a name given to rows of records with various columns of data. Not all

grids have toolbars above them.

A list is the name given to a collection of records that you can scroll through. You can bring these records into

the page by selecting them. Often, this will open a grid.
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Windows Narrator and keyboard-only access

Shortcuts for the most frequently performed actions

Navigation search

NOTENOTE

Action search for keyboard-only users or for heads-down data entry

ExampleExample

This topic describes the functionality that is designed to help users who have various disabilities use this app.

For example, there are features for people who use sight-assistive technologies such as Microsoft Windows

Narrator.

Every field and control has a label and a description of applicable shortcuts. A screen reader can read the label

and description.

For most users, everyday system use involves lots of data entry and keyboard interaction. To enhance the user

experience, we have created shortcuts to help you "jump" around the screen and shortcuts for specialized

actions. For more information, see Keyboard shortcuts.

Any page that is accessed by using the Navigation pane menu, the left-most pane, is also available from the

SearchSearch box. Press Alt+G to move focus to the SearchSearch box, and then type the name or description of the page.

For more information, see Navigation search.

You can navigate directly to top-level pages only. Secondary pages rely on information or context from their parent page.

Every action that is provided on a page can be accessed from a keyboard, via the tab sequence. Information

about the tab sequence is provided later in this topic. To run actions more directly, you can use the action search

functionality.

You want to run the Email notification logEmail notification log action that appears in the Email notificationEmail notification group on the SalesSales

orderorder  tab on the Action Pane.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/accessibility-features.md


Tab sequence

One option is to use your keyboard. Press Ctrl+F6 to move focus to the Action Pane, and then press Tab

repeatedly to move through all the tabs and actions, until the Email notification logEmail notification log action has focus.

However, you can also run the action more directly. From anywhere on the page, press Ctrl+Apostrophe (') to

show the search box for actions.

In the search box, type words that describe the action. The action is made available to you, and you can run it

directly. For example, by typing emailemail , notificnotific (a partial word), or loglog, you can "jump" to the Email notification

log functionality.

When you've finished, you can press Ctrl+Apostrophe again to return focus to the field that you were working

with before you ran the action search.

For more information, see Action search.

In everyday system use, not every field is required in order to perform typical tasks. Therefore, by default, the

tab sequence is "optimized." Tab stops are set only on those fields that are essential for typical scenarios.

However, you might find that some fields that you often use to perform tasks aren't included in the default tab

sequence. In this case, if you use Windows Narrator, you can use Windows Narrator's keyboard actions to access

those fields and inspect their content. Alternatively, you can turn on the Enhanced tab sequenceEnhanced tab sequence option on the

OptionsOptions  page. This option makes all editable and read-only fields part of the tab sequence. You can then use

page personalization to create a custom tab sequence and omit fields that don't have to be part of the tab

sequence. For more information about personalization, see Personalize the user experience.



Form patterns

Responsive layout

Guidance to help developers and customers incorporate accessible
thinking in their customizations

NOTENOTE

Almost 90 percent of the pages in the app are based on a small set of patterns. These patterns are referred to as

form patterns. Each form pattern is used to provide the actions that are most often performed on the page. A

form pattern helps guarantee familiarity and ease of understanding, because frequently used actions and data

are always presented in the same location on different pages. Because of the small number of form patterns,

users can easily learn the system, regardless of the number of pages in it, and can confidently use it after they

recognize the form patterns.

To learn more about form patterns, see Form styles and patterns.

The product is designed to work on various devices and form factors, from the smallest screens to large screens

that have the highest resolution. Our responsive layout engine lets users zoom in to a magnification level of 200

percent (or, in some scenarios, more than 200 percent).

On smartphones and other small screens, the controls and the form layout will responsively adapt to ensure

that the core data is favored. These responsive behaviors can also include reducing the number of columns in

groups and tabs to a single column, hiding shell elements, and collapsing the Action Pane.

To learn more about Microsoft best practices for enabling accessibility, see Accessibility in forms, products, and

controls.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/user-interface/form-styles-patterns
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/user-interface/enable-accessibility
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https://go.microsoft.com/fwlink/?LinkId=521839
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The Feature management workspace

Turn on a feature

Features are added and updated in every release. The Feature management experience provides a workspace

where you can view a list of features that have been delivered in each release. By default, new features are

turned off. You can use the workspace to turn them on and view the documentation for them.

You can open the Feature managementFeature management workspace by selecting the appropriate tile on the dashboard. You will

see a page that shows a list of features for all releases that are supported by the Feature management

experience. Over time, Microsoft will enhance the Feature management experience so that it includes more

functionality to help you manage features.

The feature list includes the following information:

Feature nameFeature name – A description of the feature that was added.

Enabled statusEnabled status  – A symbol indicates whether a feature has been turned on (check mark), hasn't been turned

on (blank), is scheduled to be turned on (clock), is mandatorily turned on (lock), requires attention before you

turn it on (warning), or can't be enabled (X). The setting that is shown is used for all legal entities. Note that

even when a feature has been turned on, it's still controlled by security. Therefore, the feature will be

available only to users who have access to it, based on their security role. It will also be available only in legal

entities that the user has access to.

Enable dateEnable date – The date when the feature was turned on or is scheduled to be turned on.

Feature addedFeature added – The date when the feature was added to your environment. This date is automatically

entered when you update your environment during the monthly release cycles.

ModuleModule – The module that is affected by the new feature.

When you select a feature, more information appears in the details pane to the right of the feature list. At the top

of the pane, you will see the feature name, the date when the feature was added, the module that is affected by

the feature, and a Learn moreLearn more link. Select this link to view the documentation for the feature. If documentation

isn't available, you're taken to a temporary page. The details pane also includes a CommentsComments  field where you

can add your own comments about the feature.

The Feature managementFeature management workspace also has several tabs, each of which shows a list of features.

NewNew  – This tab shows all features that have been added since the last monthly update. If you've skipped any

monthly updates, the tab shows all the new features that have been added since the last time that you

updated. The newest features appear at the top of the list. The total number of new features is also shown on

a tile at the top of the page.

Not enabledNot enabled – This tab shows all features that haven't been turned on. The newest features appear at the

top of the list. The total number of new features that haven't been turned on is also shown on a tile at the top

of the page.

ScheduledScheduled – This tab shows all features that have been scheduled to be turned on in the future. The features

that have the earliest scheduled date appear at the top of the list. The total number of schedule new features

is also shown on a tile at the top of the page.

AllAll  – This tab shows all features. The newest features appear at the top of the list.

If a feature hasn't been turned on, an Enable NowEnable Now  button appears in the details pane. You can use this button to

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/feature-management/feature-management-overview.md


Reschedule a feature

Turn off a feature

Features that must be turned on

Enable all features

turn on the feature.

Select the feature to turn on, and then, in the details pane, select Enable NowEnable Now . The feature is turned on.

Some features can't be turned off after you turn them on. If the feature that you're trying to turn on can't be

turned off, you receive a warning. At that point, you can select CancelCancel  to cancel the operation and leave the

feature turned off. However, if you select EnableEnable to turn on the feature, you won't be able to turn it off later.

Some features will display a message that provides additional information before you turn them on. These

features are indicated by a yellow warning symbol. You should read the additional information carefully to

better understand what will happen when the feature is enabled. However, you can still select EnableEnable to turn on

the feature.

Some features will display a message that the feature can't be enabled until an action is taken. These features

are indicated by a red X symbol. You must take the actions described in the description before the feature is

enabled. For example, if you can't use a feature until a configuration key is disabled, then you must disable the

configuration key first and then return to Feature management to enable the feature.

After a feature is turned on, a message appears below the Learn moreLearn more link in the details pane. This message

either states that the feature was turned on or it indicates that the future date when the feature is scheduled to

be turned on. It appears every time that you select the feature in the feature list.

Features that are scheduled to be turned on in the future appear on the ScheduledScheduled tab. A batch process will

turn them on at midnight on the specified date, based on the time zone that is represented by the system date.

If a feature has been scheduled to be turned on in the future, a ScheduleSchedule button appears in the details pane. You

can use this button to change the Enable dateEnable date value to a different date.

1. Select the scheduled feature to reschedule, and then, in the details pane, select ScheduleSchedule.

2. In the dialog box that appears, in the Enable dateEnable date field, specify the new date when the feature should be

turned on.

3. Select EnableEnable to reschedule the feature or DisableDisable to cancel the schedule.

If a feature has already been turned on, a DisableDisable button appears in the details pane. You can use this button to

turn off the feature. The DisableDisable button isn't available if the feature can't be turned off after it's turned on.

Select the feature to turn off, and then, in the details pane, select DisableDisable. The feature is turned off, and the

Enable dateEnable date field is cleared.

After a feature is turned off, a message appears below the Learn moreLearn more link in the details pane. This message

states that the feature hasn't yet been turned on. It appears every time that you select the feature in the feature

list. Features that haven't been turned on appear on the Not enabledNot enabled tab.

Sometimes, a critical feature is delivered that must be turned on automatically when you do an update. These

features will be turned on automatically on the date that is specified in the Enable dateEnable date field. For these features,

a message appears below the Learn moreLearn more link in the details pane. This message either states that the feature

was turned on or indicates the future date when the feature will be turned on. It appears every time that you

select the feature in the feature list.

By default, all features that are added to your environment are turned off. You can enable all features by



Turn on all features automatically

Check for updates

Assigning roles

Features that use configuration keys

Data entities

selecting the Enable allEnable all  button.

When you select Enable allEnable all , an option will appear where you need provide the following information:

A list of all features that require confirmation before they can be enabled. If you want to enable the features

in the list, select YesYes  for the Enable features requir ing confirmationEnable features requir ing confirmation button.

A list of all features that can't be enabled will be shown. Those features will not be enabled.

All features that can be enabled will be enabled. If a feature is already scheduled to be enabled in the future, the

schedule will not change.

By default, all features that are added to your environment are turned off, unless they are mandatory features.

However, if you want to automatically turn on all new features, you can use the drop-down list under the

workspace title to change what occurs when new features are added.

Select Enable new features automatically  to automatically turn on all new features when they are added to

your environment.

Select Do not enable new features automatically  to default all new features to off when they are added to

your environment.

When you enable all feature automatically, it will enable all of the features that would be enabled when you click

the Enable allEnable all  button. It will not enable the features that require confirmation or the features that can't be

enabled until an action is taken.

Features are added to your environment after each update. However, you can manually check for updates by

clicking on the Check for updatesCheck for updates  button. Any feature that was added to the system after the update will be

added to the list of features. For example, if a flighted feature is enabled after a release, then you can check for

updates and the feature will be added to your list.

The Feature managementFeature management workspace can be opened by system admins, and also by users who are assigned

to the Feature manager role or the Feature viewer role. These two roles were created to support the Feature

management experience. Users in the Feature manager role can turn any feature on or off. They can also update

the CommentsComments  field for the feature. Users in the Feature viewer role can only view the Feature managementFeature management

workspace. They can't turn features on or off.

The Feature manager role and Feature viewer role don't override the existing security that a user has. They just

control whether the user can turn features on and off. They don't provide access to the features themselves.

If a feature uses a configuration key, but the configuration key isn't turned on, the Feature managementFeature management

workspace doesn't show the feature in the list of available features. After you turn on the configuration key, you

must update the feature list by using the Check for updateCheck for update menu item. The feature then appears in the feature

list.

If you turn off the configuration key, the feature isn't removed from the feature list.

A data entity that is named Feature managementFeature management lets you export the Feature management settings from one

environment and then import them into another environment. This entity updates only existing features. The



Feature management and flighting

New features are optional for 12 months

Using Feature management to turn on ISV features or custom
features

Frequently asked questions (FAQ)
When are features added, removed, or changed?When are features added, removed, or changed?

Does a feature become mandatory automatically?Does a feature become mandatory automatically?

When do features become mandatory?When do features become mandatory?

Why isn't there a specific 'mandatory-enabled date'?Why isn't there a specific 'mandatory-enabled date'?

business logic in the entity also helps guarantee that the same rules that are used on the FeatureFeature

managementmanagement workspace will be applied when the import is done. For example, you can't override a mandatory

feature setting by removing the date during import.

The following examples describe what occurs when you use the Feature managementFeature management entity to import data.

If you change the value of the EnabledEnabled field to YesYes , the feature is turned on, and the Enable dateEnable date field is set

to the current date.

If you change the value of the EnabledEnabled field to NoNo or leave the EnableDateEnableDate field blank, the feature is turned

off, and the Enable dateEnable date field is cleared. You can't turn off a mandatory feature or a feature that can't be

turned off after it's turned on.

If you change the value of the EnableDateEnableDate field to a future date, the feature is scheduled for that date.

If you change the value of the EnabledEnabled field to YesYes  and change the value of the EnableDateEnableDate field to a future

date, the feature is scheduled for that date.

If you change the value of the EnabledEnabled field to NoNo, but you also change the value of the EnableDateEnableDate field to

a future date, the feature is scheduled for that date.

If a feature is turned on, and you add an EnableDateEnableDate field that is set to a future date, the feature remains

turned on. To reschedule the feature, you must change the EnabledEnabled field to NoNo.

Feature management lets you control the features that are delivered in each release. Flighting lets Microsoft

teams release features to a limited number of customers, so that those features can be tested and validated

without affecting all customers. Feature management doesn't control the flighting of any features.

When a new non-critical feature is installed, it will be optional for a 12-month period. This allows you and your

organization time to plan ahead for when to uptake a feature and have it tested against your daily operations.

For more information, see One Version service updates FAQ.

Feature management is currently unavailable for features from independent software vendors (ISVs) and

custom features. However, Microsoft is adding more functionality to enhance Feature management. After those

enhancements are completed, Microsoft will make Feature management available to all features and provide

instructions for updating your features to use it.

Features are added, removed, and changed through code changes. Environments need to be updated to receive

those changes.

No, a feature becoming mandatory is not an automatic action. The product teams need to make a code change.

The policy is that all new features will be opt-in for a 12-month period and will not require any change

management until you enable the feature. The product teams can choose whether to make a feature mandatory

after that period has ended.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/one-version#what-about-new-features


Where's the documentation for features that are being made mandatory?Where's the documentation for features that are being made mandatory?

Is there an in-product notification or signal that a feature is going to be mandatory-enabled?Is there an in-product notification or signal that a feature is going to be mandatory-enabled?

Do features ever get enabled without the customer knowing about it?Do features ever get enabled without the customer knowing about it?

What is feature flighting and how does it relate to feature management?What is feature flighting and how does it relate to feature management?

Do features ever get flighted off without the customer knowing about it?Do features ever get flighted off without the customer knowing about it?

How can feature enablement be checked in code?How can feature enablement be checked in code?

if (FeatureStateProvider::isFeatureEnabled(BatchContentionPreventionFeature::instance()))

How can feature enablement be checked in metadata?How can feature enablement be checked in metadata?

What is a feature class?What is a feature class?

[ExportAttribute(identifierStr(Microsoft.Dynamics.ApplicationPlatform.FeatureExposure.IFeatureMetadata))]
internal final class BankCurrencyRevalGlobalEnableFeature implements IFeatureMetadata

What is the IFeatureLifecycle implemented by some feature classes?What is the IFeatureLifecycle implemented by some feature classes?

Update release timing is variable, environment update timing is variable, and customers can opt to skip some

updates. As a result, specific dates are difficult to determine.

This documentation comes from the application teams. Often, these will be mentioned in Removed or

deprecated features.

A notification mechanism related to making a feature mandatory does not exist today.

Yes, if features don't have a functional impact then they can be enabled by default.

Feature flights are real-time on/off switches that Microsoft controls. They are separate from the customer

control provided by Feature Management.

Private Preview features will not be listed in Feature Management until they are flighted on. In production,

the customer needs to agree to be part of a special program for that to occur.

Public Preview and Released (generally available) features will be listed in Feature Management unless they

are flighted off. Flighting a feature off is considered a last resort option for product teams if a critical issue is

found and would usually be a per-customer operation.

Yes, if a feature is impacting the functioning of an environment that doesn't have a functional impact then they

can be enabled by default.

Use the isFeatureEnabledisFeatureEnabled method on the FeatureStateProviderFeatureStateProvider  class, passing it an instance of the feature

class. Example:

The FeatureClassFeatureClass  property can be used to indicate that some metadata is associated with a feature. The class

name used for the feature should be used, such as BatchContentionPreventionFeatureBatchContentionPreventionFeature. This metadata is

visible only in that feature. The FeatureClassFeatureClass  property is available on menus, menu items, enum values, and

table/view fields.

Features in Feature Management are defined as feature classes. A feature class implementsimplements

IFeatureMetadataIFeatureMetadata and uses the feature class attribute to identify itself to the Feature Management workspace.

There are numerous examples of feature classes available that can be checked for enablement in code using the

FeatureStateProviderFeatureStateProvider  API and in metadata using the FeatureClassFeatureClass  property. Example:

IFeatureLifecycle is a Microsoft-internal mechanism for indicating the feature lifecycle stage. Features can be:

PrivatePreview  - Needs a flight to be visible.

PublicPreview  - Shown by default but with a warning that the feature is in preview.

Released  - Fully released.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/migration-upgrade/deprecated-features
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Why aren't symbols loaded?

I miss the ribbon from Dynamics AX 2012. Can I keep Action Pane
tabs open all the time?

Why do I sometimes see different shortcut menus when I right click?

Where is the View details functionality?

NOTENOTE

This article provides answers to frequently asked questions about the Finance and Operations client.

The security settings on your browser might prevent the symbols from being loaded correctly. To resolve this

issue, try the following steps:

If you're experiencing this issue in Internet Explorer, click ToolsTools , and then click Internet OptionsInternet Options . In the

Internet Options dialog box, on the Pr ivacyPrivacy  tab, click Custom levelCustom level , and make sure the Font downloadFont download

option is selected.

Otherwise, you might have to add the app site to the list of trusted sites.

We are planning to implement this feature soon. Users will then be able to choose to keep the tabs on Action

Panes open all the time. Otherwise, the tabs will be collapsed when they aren't being used, to gain more screen

space for the page.

If you right-click in an editable field (or if text is selected), the browser's shortcut menu is displayed. This menu

gives you access to the CutCut, CopyCopy , and PastePaste commands. We can't embed these commands into the shortcut

menus because, for security reasons, browsers don't allow us to programmatically access the system clipboard.

If you right-click a field label or the value of a read-only control, you'll see the shortcut menu.

To make keyboard access easier, we plan to implement a keyboard shortcut in the future that will open the

shortcut menu.

The View detailsView details  option is available in a couple of ways:

If a control has View detailsView details  capabilities, and if the control has a value, that value is displayed as a hyperlink.

You can click the hyperlink to open a page that contains additional details.

View detailsView details  is also an option on shortcut menus. For more information about when shortcut menus are

displayed when you right-click, see the previous section.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/client-faq.md
https://aka.ms/BAG_Docs_Language_Survey
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Introduction

Using action search

This article describes the action search functionality. Action search will help you find and run actions on a page.

Pages primarily expose commands on Action Panes, both the standard Action Pane that appears at the top of a

page and the toolbars that appear in various sections of the page. In previous versions, a Key Tips feature let you

quickly access any button on an Action Pane by pressing the Alt key and then a series of letters.

The action search feature replaces Key Tips, which are no longer available. This new feature lets you quickly

search for and run a button from any visible Action Pane.

To use the action search feature, follow these steps.

1. On the Action Pane, click in the action searchaction search field. (The action searchaction search field contains a magnifying glass

icon.)

2. Type all or part of the name of the button that you want to run. You can also search by using words from the

button's "path." (For more information, see the next section of this article.) Typically, a button will appear near

the top of the results list after you've typed two to four characters.

3. Find and run the button in the results list (by using your mouse or keyboard).

After the button is run, the focus is returned to your last position on the page, so that you can continue to work.

You can also start action search by pressing Ctrl+/ or Alt+Q. Press the keyboard shortcut again to return the

focus to your last position on the page.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/action-search.md
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/media/keytipsax6.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/media/action-search-field.png


Understanding the results list
Often, you must know both the location and the context of a button to fully understand the purpose of that

button. Therefore, the results list shows additional information to help you understand exactly which buttons

appear in the list. In particular, the "path" of the button is shown. This path might include the labels of the

following UI elements, as relevant:

Action Pane tab

Button group

Menu button (if the button is inside a menu button)

Menu separator (if the button is inside a named group inside a menu button)

Group or tab on the page (for example, the name of a FastTab)

For example, you typed tottot in the action searchaction search field and are now examining the results list. The first entry, for

a button that is named TotalsTotals , is highlighted. A button path of Sales orderSales order  > ViewView  is also shown. The SalesSales

orderorder  part of the path corresponds to the Sales orderSales order  tab on the Action Pane, and the ViewView  part of the path

corresponds to the ViewView  group on that tab. Similarly, the path of the Total discountTotal discount button (SellSell  > CalculateCalculate)

informs you that this button is located in the CalculateCalculate group on the SellSell  tab of the Action Pane. Therefore, this

information helps you understand exactly which button will be triggered by action search (if you select that

button in the results list).

In the previous example, action search showed results from the standard Action Pane at the top of a page.

However, action search also shows results from visible toolbars that are in other places on the page. For

example, you're searching for the On-hand inventor yOn-hand inventor y  button that is on the Sales order linesSales order lines  FastTab. In this

case, the button path in the results list (Sales order linesSales order lines  > Inventor yInventor y  > ViewView ) informs you that this button is

under the ViewView  heading on the Inventor yInventor y  menu button on the Sales order linesSales order lines  FastTab.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/media/action-search-field-with-data.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/media/on-hand-inventory.png


NOTENOTE

Action search vs. Navigation search

NOTENOTE

There are some buttons that do not show up in Action search. These include drop dialog buttons and buttons from

subforms.

Whereas action search is intended to find and run actions on a page, there is a separate search mechanism for

finding and navigating to pages. For more information about that feature, see the Navigation search article.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Advanced query syntax

SY N TA XSY N TA X C H A RA C T ER DESC RIP T IO NC H A RA C T ER DESC RIP T IO N DESC RIP T IO NDESC RIP T IO N EXA M P L EEXA M P L E

value Equal to the value that is
entered

Type the value to find. SmithSmith finds "Smith".

!value (exclamation point) Not equal to the value that
is entered

Type an exclamation point
and then the value to
exclude.

!Smith!Smith finds all values
except "Smith".

from-value..to-value
(double period)

Between the two values
that are separated by
double periods

Type the from-value, then
two periods, and then the
to-value.

1..101..10  finds all values from 1
through 10. However, in a
string field, A..CA..C  finds all
values that start with "A"
and "B", and values that are
exactly equal to "C". For
example, this query won't
find "Ca". To find all values
from "A" through "C", type
A..DA..D .

..value (double period) Less than or equal to the
value that is entered

Type two periods and then
the value.

..1000..1000  finds any number
that is less than or equal to
1000, such as "100",
"999.95", and "1,000".

value.. (double period) Greater than or equal to
the value that is entered

Type the value and then
two periods.

1000..1000..  finds any number
that is greater than or equal
to 1000, such as "1,000",
"1,000.01", and
"1,000,000".

>value (greater than sign) Greater than the value that
is entered

Type a greater than sign (>>)
and then the value.

>1000>1000  finds any number
that is greater than 1000,
such as "1000.01",
"20,000", and "1,000,000".

<value (less than sign) Less than the value that is
entered

Type a less than sign (<<)
and then the value.

<1000<1000  finds any number
that is less than 1000, such
as "999.99", "1", and "-200".

value* (asterisk) Starting from the value that
is entered

Type the starting value and
then an asterisk (** ).

S*S*  finds any string that
starts with "S", such as
"Stockholm", "Sydney", and
"San Francisco".

This topic describes the filtering and query options that are available when you use the Advanced filter/sort

dialog or the matchesmatches  operator in the Filter pane or grid column header filters.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/advanced-filtering-query-options.md


*value (asterisk) Ending with the value that
is entered

Type an asterisk and then
the ending value.

*east*east  finds any string that
ends with "east", such as
"Northeast" and
"Southeast".

*value* (asterisk) Containing the value that is
entered

Type an asterisk, then a
value, and then another
asterisk.

*th**th*  finds any string that
contains "th", such as
"Northeast" and
"Southeast".

? (question mark) Having one or more
unknown characters

Type a question mark at the
position of the unknown
character in the value.

Sm?thSm?th finds "Smith" and
"Smyth".

value,value (comma) Matching the values that
are separated by commas

Type all your criteria, and
separate them by using
commas.

A , D, F, GA , D, F, G  finds exactly "A",
"D", "F", and "G". 10, 20,10, 20,
30, 10030, 100  finds exactly "10,
20, 30, 100".

"" (two double quotes) Matching a blank value Type two consecutive
double quotes to filter for
blank values in that field.

Two consecutive double
quotes ("""") finds rows with
no value for the current
column.

(Finance and Operations
query) (Finance and
Operations query between
parentheses)

Matching a defined query Type a query as an SQL
statement between
parentheses using the
Finance and Operations
query language.

((AccountNum LIKE((AccountNum LIKE
"US*") &&"US*") &&
(DirPar tyTable.Name(DirPar tyTable.Name
LIKE "Cont*"))LIKE "Cont*"))

as an example of syntax for
a filter condition on a field
from the root datasource as
well as a field from a
different datasource (for the
All customers page)

T Today's date Type TT. TT matches today's date.

SY N TA XSY N TA X C H A RA C T ER DESC RIP T IO NC H A RA C T ER DESC RIP T IO N DESC RIP T IO NDESC RIP T IO N EXA M P L EEXA M P L E



(methodName(parameters))
(SysQuer yRangeUtilSysQuer yRangeUtil
method between
parentheses)

Matching the value or
range of values that are
specified by the parameters
of the
SysQuer yRangeUtilSysQuer yRangeUtil
method

Type a
SysQuer yRangeUtilSysQuer yRangeUtil
method that has
parameters that specify the
value or range of values.

See the table in the next
section for additional details
about
SysQuer yRangeUtilSysQuer yRangeUtil date
methods, and several
examples.

SY N TA XSY N TA X C H A RA C T ER DESC RIP T IO NC H A RA C T ER DESC RIP T IO N DESC RIP T IO NDESC RIP T IO N EXA M P L EEXA M P L E

Advanced date queries that use SysQueryRangeUtil methods

M ET H O DM ET H O D DESC RIP T IO NDESC RIP T IO N EXA M P L EEXA M P L E

Day (_relativeDays=0) Find a date relative to the session date.
Positive values indicate future dates,
and negative values indicate past
dates.

DayRange (_relativeDaysFrom=0,
_relativeDaysTo=0)

Find a range of dates relative to the
session date. Positive values indicate
future dates, and negative values
indicate past dates.

GreaterThanDate (_relativeDays=0)
GreaterThanUtcDate (_relativeDays=0)

Find all dates after the specified
relative date.

1. Click AccountsAccounts
receivablereceivable >
InvoicesInvoices > OpenOpen
customercustomer
invoicesinvoices .

2. Press Ctrl+Shift+F3
to open the Inquir yInquir y
page.

3. On the RangeRange tab,
click AddAdd.

4. In the TableTable field,
select OpenOpen
customercustomer
transactionstransactions .

5. In the FieldField field,
select Due dateDue date.

6. In the CriteriaCriteria field,
enter (yearRange(-(yearRange(-
2,0))2,0)) .

7. Click OKOK. The list
page is updated and
lists the invoices
that match the
criterion that you
entered. For this
example, invoices
that were due in the
previous two years
are listed.

TomorrowTomorrow – Enter (Day(1))(Day(1)) .

TodayToday – Enter (Day(0))(Day(0)) .

YesterdayYesterday  – Enter (Day(-1))(Day(-1)) .

Last 30 daysLast 30 days – Enter
(DayRange(-30,0))(DayRange(-30,0)) .

Previous 30 days and nextPrevious 30 days and next
30 days30 days – Enter (DayRange(-(DayRange(-
30,30))30,30)) .

More than 30 days fromMore than 30 days from
nownow – Enter
(GreaterThanDate(30))(GreaterThanDate(30)) .



GreaterThanUtcNow () Find all date/time entries after the
current time.

LessThanDate (_relativeDays=0)
LessThanUtcDate (_relativeDays=0)

Find all dates before the specified
relative date.

LessThanUtcNow () Find all date/time entries before the
current time.

MonthRange (_relativeFrom=0,
_relativeTo=0)

Find a range of dates, based on
months relative to the current month.

YearRange (_relativeFrom=0,
_relativeTo=0)

Find a range of dates, based on years
relative to the current year.

M ET H O DM ET H O D DESC RIP T IO NDESC RIP T IO N EXA M P L EEXA M P L E

NOTENOTE

All future date/timesAll future date/times – Enter
(GreaterThanUtcNow())(GreaterThanUtcNow()) .

Less than seven days fromLess than seven days from
nownow – Enter
(LessThanDate(7))(LessThanDate(7)) .

All past date/timesAll past date/times – Enter
(LessThanUtcNow())(LessThanUtcNow()) .

Previous two monthsPrevious two months –
Enter (MonthRange(-2,0))(MonthRange(-2,0)) .

Next three monthsNext three months – Enter
(MonthRange(0,3))(MonthRange(0,3)) .

Next yearNext year  – Enter
(YearRange(0, 1))(YearRange(0, 1)) .

Previous yearPrevious year  – Enter
(YearRange(-1,0))(YearRange(-1,0)) .

Can you tell us about your documentation language preferences? Take a short survey.
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https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Configure and filter workspaces
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Configuring a workspace

This article provides an overview about how to configure and filter workspaces.

You can change the appearance and behavior of some workspaces by updating settings that apply to the whole

workspace. When a workspace can be configured, the Action Pane includes a button that instructs you to click it

to make configuration changes. For example, in the following illustration, the button is named Configure myConfigure my

workspaceworkspace.

When you click the button, a dialog appears, where you can modify the predefined settings for the workspace.

The specific settings that you see in this dialog vary by workspace, and depend on the specific controls and

business data that are available in the workspace.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/configure-filter-workspaces.md
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/media/configure-and-filter-workspaces.png


Filtering a workspace

Workspace-wide filtersWorkspace-wide filters

Many workspaces let you filter the content that appears in them. The controls that are available might let you

filter all the content in the workspace or only the content in a specific section of the workspace. The filters on

workspaces can be lookups, combo boxes, free-form text fields, or other types of controls. However, every type

of filter has the same effects, as described in the following sections.

You can filter the whole workspace by using a workspace-wide filter. A workspace-wide filter appears in the

upper-left corner of the workspace. When you select a specific value in the drop-down list, the contents of the

workspace are filtered based on that selection.

When you click to open the filter, you're presented with several options.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/media/configure-my-workspace.png
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Workspace section filtersWorkspace section filters

NOTENOTE

Select an option to filter the workspace based on that option.

If individual sections of the workspace have filters, you can filter each section separately. In the following

illustration, the filter (the field that contains the text "Filter") is an example of a free-form text field filter.

As with a workspace-wide filter, select or enter a value in the field to filter the contents of the section.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Show pages side-by-side using the Open in new
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This article explains how to display pages side by side.

You may want to view multiple pages side by side to complete tasks quickly. As an example, you might want to

validate or enter lines in more than one journal. Typically, to validate or enter lines in more than one journal, you

would have to go back and forth between the page that displays a list of journals, and the page that displays

lines for a given journal. However, the Open in new windowOpen in new window  feature enables you to display these pages side-

by-side so that you can perform your tasks quickly.

Continuing with the example mentioned above, when viewing the lines, you can click the Open in newOpen in new

windowwindow  icon.

Clicking the Open in new windowOpen in new window  icon opens the lines page in a new, pop-up browser, and then navigates the

original browser back in history to the page that displayed the list of journals. You can then display both pages

side by side. After viewing a journal, you can change the selected journal on the journal list page, and the lines

page in the pop-up window will automatically display the lines of the newly selected journal.

The dynamic linking and refreshing happens due to the relations that exist between the data that is backing

these pages. If the system is not aware of the relation between the data, the pop-up window will not refresh

automatically in response to a change in the window it originated from.

Some pages have multiple views such as the Grid view, Header view, and Details view. The Open in newOpen in new

windowwindow  icon causes the entire page to open in the new browser window. Therefore, you cannot keep two views

of the same page side by side using the Open in new windowOpen in new window  feature. Almost all such pages have a

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/display-pages-side-by-side.md
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NOTENOTE

navigation list that you can use to switch between records and achieve a similar experience.

Before using the Open in new windowOpen in new window  feature, you should configure your browser's pop-up blocker to allow

pop-ups from the URL of the site. As an example, you could allow pop-ups from "*.dynamics.com".

The Open in new windowOpen in new window  feature is only available when there is more than one page open in the window.

Also, the pop-up window automatically closes when there are no more pages open (that is, when you close the

last page in that window). The system also closes open pages when you navigate to a different area in the

application. Therefore, if you have pop-up windows open and navigate to a different area in the application, the

pop-up windows close automatically because the system closed the pages in those windows.

The top bar in the pop-up windows displays information about the company the page was opened in and is

read-only. The pop-up windows also rely on the main browser window. If the main window is closed or

refreshed, all open pop-up windows will become read only. If this situation occurs, you can still view the

information in these windows, but you will not be able to interact with it.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Keyboard shortcuts
2/18/2021 • 9 minutes to read • Edit Online

NOTENOTE

Finding a shortcut

Action shortcuts

TO  DO  T H ISTO  DO  T H IS P RESSP RESS

Open action search Ctrl+' or Alt+Q

Move to the standard Action Pane Alt+M,A or Ctrl+F6

Open a tab on the Action Pane or a menu Enter or Space or Alt+Down arrow

Move to next/previous option in a menu Down arrow / Up arrow

Close a tab on the Action Pane or a menu Esc

Simulate a right-click Shift+F10

Open the context menu Ctrl+F10

Execute the default button on a form/dialog box Alt+Enter

Click a button or tile Enter or Space

View refresh information for a count tile Alt+Up arrow

View currently available shortcuts Alt+Shift+K

Date picker shortcuts

The following keyboard shortcuts can help you quickly and efficiently enter data in Finance and Operations apps

.

The keyboard shortcuts described here refer to the United States keyboard layout. Keys on other keyboard layouts might

not correspond exactly to the keys on a US keyboard.

Some of the shortcuts on this page are key chords, meaning they require two consecutive sets of key

combinations (separated by a comma) that need to be independently pressed to trigger the required action. For

example, the shortcut "Alt+M,A" requires the user to first press "Alt+M", release the keys, and then press "A".

As of Platform update 11, users can discover currently available shortcuts directly from the user interface.

Simply right-click on a control and select View shor tcutsView shor tcuts . This will open a dialog box showing the shortcuts

you can use based on where you are on the page.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/shortcut-keys.md


TO  DO  T H ISTO  DO  T H IS P RESSP RESS

Open the date picker Alt+Down arrow

Move between dates in the date picker Ctrl+Arrow keys

Move to the next/previous month Page down / Page up

Move to the next/previous year Ctrl+Shift+Page down / Ctrl+Shift+Page up

Move to today Ctrl+Home

Pick today's date T

Clear the selected date C

Pick Never (or the max date) N

FactBox shortcuts

TO  DO  T H ISTO  DO  T H IS P RESSP RESS

Open the FactBox pane (or move focus to the FactBox pane
if it is already open)

Alt+M,B or Ctrl+F2

Close the FactBox pane (with focus in the FactBox pane) Esc

Move to the next/previous FactBox (with focus in the FactBox
pane)

Alt+Shift+Down arrow / Alt+Shift+Up arrow

Move to the <n>th FactBox (with focus in the FactBox pane) Alt+<n> (<n> = 1-9)

Expand a FactBox (with focus on the FactBox header) Space or Enter

Collapse the current FactBox Alt+0

Filtering shortcuts

TO  DO  T H ISTO  DO  T H IS P RESSP RESS

Open grid filtering for the current column Ctrl+G

Close grid filtering for the current column Esc

Open the Filter pane (or switch focus between the Filter
pane and the main form if the Filter pane is already open)

Alt+M,F or Ctrl+F3

Close the Filter pane (with focus in the Filter pane) Esc

Open advanced filtering/sort Ctrl+Shift+F3



Form shortcuts

TO  DO  T H ISTO  DO  T H IS P RESSP RESS

Create a new record Alt+N

Delete a record Alt+Del or Alt+F9

Save record Alt+S or Ctrl+S

Revert (restore) Ctrl+Shift+F5

Data refresh Shift+F5

Move to the visible first field on the form Alt+Shift+F

Toggle edit mode F2

Attach a document Ctrl+Shift+A

Export to Excel Ctrl+Shift+E

Move to the previous record (outside a grid) Ctrl+Up arrow

Move to the next record (outside a grid) Ctrl+Down arrow

Move to the first record (outside a grid) Ctrl+Home

Move to the last record (outside a grid) Ctrl+End

Close the form (click Back) Esc

Close the form with explicit save Shift+Esc

Close the form discarding any unsaved changes Alt+Shift+Q

Form navigation shortcuts

TO  DO  T H ISTO  DO  T H IS P RESSP RESS

Move to the next/previous field Tab / Shift+Tab

Move to the next/previous tab Alt+Shift+Right arrow / Alt+Shift+Left arrow

Move to the <n>th tab Alt+Shift+<n> (<n> = 1-9)

Move to the next/previous FastTab Alt+Shift+Down arrow / Alt+Shift+Up arrow

Move to the <n>th FastTab Alt+<n> (<n> = 1-9)

Move to the next/previous blade (vertical tab) Alt+Shift+Right arrow / Alt+Shift+Left arrow



Move to the <n>th blade (vertical tab) Alt+Shift+<n> (<n> = 1-9)

Expand a FastTab (with focus on the FastTab header) Space or Enter

Collapse the current FastTab Alt+0

Switch to grid view Ctrl+Shift+G

Switch to details view Ctrl+Shift+D

Switch to header view Ctrl+Shift+H

Switch to lines view Ctrl+Shift+L

TO  DO  T H ISTO  DO  T H IS P RESSP RESS

Grid shortcuts

TO  DO  T H ISTO  DO  T H IS P RESSP RESS

Move to the next/previous column Tab / Shift+Tab

Move to the next/previous row Down arrow / Up arrow

Move to the next/previous row without selecting

[!NOTE] This shortcut applies to multi-select scenarios
only.

Ctrl+Up arrow / Ctrl+Down arrow

Select/clear the current row

[!NOTE] This shortcut applies to multi-select scenarios
only.

Ctrl+Space / Ctrl+Click

Add the next/previous row to the selected set

[!NOTE] This shortcut applies to multi-select scenarios
only.

Shift+Space

Add a range of rows to the selected set

[!NOTE] This shortcut applies to multi-select scenarios
only.

Shift+Click

Go to the next/previous page of data Page up / Page down

Create a new row at the bottom of the grid Down arrow (from the last row)

Move to the first record Ctrl+Home



Move to the last record Ctrl+End

Select or clear all rows Ctrl+Shift+M

Move to the first marked row Alt+Shift+M, F

Move to the next marked row Alt+Shift+M, L

Move to the previous marked row Alt+Shift+M, P

Moved to the last marked row Alt+Shift+M, N

Execute the default action in a grid

[!NOTE] This shortcut is enabled when focus is on a cell
containing a hyperlink and all cells in that column have
hyperlinks.

Enter

Toggle focus between the selected row and the header row Alt+Shift+H

Make the current column larger/smaller (with focus in the
header row)

Right arrow / Left arrow

Open grid filtering for the current column (with focus in the
header row)

Enter

TO  DO  T H ISTO  DO  T H IS P RESSP RESS

Input control shortcuts

TO  DO  T H ISTO  DO  T H IS P RESSP RESS

Open the hyperlink Ctrl+Enter

Enter the session date in a date field D

Enter the current date in a date field T

Open lookup, combo box, date picker, drop dialog box Alt+Down arrow

Close lookup, combo box, date picker, drop dialog box Esc

Move focus into a lookup (when the lookup is already open) Alt+Down arrow

Open the control's enhanced preview Alt+Up arrow

Select text in the current field Ctrl+A

Enter/leave the text area in an HTML editor control Alt+Down arrow / Alt+Up arrow

Switch focus between the text area and the toolbar in an
HTML editor control

F6



Messaging shortcuts

TO  DO  T H ISTO  DO  T H IS P RESSP RESS

Go to the Message Center Ctrl+Shift+F7

Go to the Message Bar Ctrl+F7

Navigation shortcuts

TO  DO  T H ISTO  DO  T H IS P RESSP RESS

Go to the dashboard Alt+Shift+Home

Move to the navigation bar Alt+M,N or Alt+Shift+F1

Move to the company picker Ctrl+Shift+O

Search for a page Ctrl+/ or Alt+G

Open the help pane Ctrl+?

Open the trace parser Alt+Shift+T

Move to the navigation pane Alt+F1

Add/remove form as a favorite (with focus on a form in the
navigation pane)

Shift+F

Move to the standard Action Pane Alt+M,A or Ctrl+F6

Move to the Filter pane (which may include opening it) Alt+M,F or Ctrl+F3

Move focus to the page content (with focus in the Filter
pane)

Alt+M,M or Ctrl+F3

Move to the navigation list on Details form (which may
include opening it)

Alt+M,S or Ctrl+F8

Move focus to the page content (with focus in the
navigation list)

Alt+M,M or Ctrl+F8

Close the navigation list on Details form (with focus in the
navigation list)

Esc

Move to the main page content (with focus in another pane) Alt+M,M

Move to the FactBox pane (which may include opening it) Alt+M,B or Ctrl+F2

Personalization shortcuts
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Transition the page into personalization mode Ctrl+Shift+P

Use the Select tool (when in personalization mode) S

Open the selected control's quick personalization dialog box
(when using the Select tool)

Space or Enter

Use the Move tool (when in personalization mode) M

Select the current control as the one to move (when using
the Move tool and no control has been selected to move
yet)

Space or Enter

Clear the control to move (when using the Move tool) Esc

Move to the next position for the selected control (when
using the Move tool)

Tab or Right arrow or Down arrow

Move to the previous position for the selected control (when
using the Move tool)

Shift+Tab or Left arrow or Up arrow

Use the Hide tool (when in personalization mode) H

Switch whether the current control is visible or hidden (when
using the Hide tool)

Space or Enter

Use the Skip tool (when in personalization mode) K

Switch whether the current control is in the tab sequence
(when using the Skip tool)

Space or Enter

Use the Edit tool (when in personalization mode) E

Switch whether the current control is editable or read-only
(when using the Edit tool)

Space or Enter

Use the Summary tool (when in personalization mode) U

Switch whether the current control is a summary field in the
current fast tab (when using the Summary tool)

Space or Enter

Use the Add tool (when in personalization mode) A

Select the control whose container will be used to insert the
new fields (when using the Add tool)

Space or Enter

Import a personalization (when in personalization mode) I

Export a personalization (when in personalization mode) X

Clear this page's personalizations (when in personalization
mode)

Ctrl+C



Move focus between the personalization toolbar and the
page (when in personalization mode)

T

Exit personalization mode (when in personalization mode) Esc

TO  DO  T H ISTO  DO  T H IS P RESSP RESS

Segmented entry shortcuts

TO  DO  T H ISTO  DO  T H IS P RESSP RESS

Open the drop-down list (when the drop-down list is closed) Alt+Down arrow

Move focus into the input field for the current segment in
the drop-down list (when the drop-down list is already
open)

Alt+Down arrow

Close the drop-down list Alt+Up arrow

Close/open the right portion of the drop-down list Alt+Left arrow / Alt+Right arrow

Switch between "Show valid" and "Show all" modes Alt+W

Select the value from drop-down list and move to the next
segment

Enter

Move to the next/previous control on the page (when focus
is in input control)

Tab / Shift+Tab

Move to the next/previous input field in the flyout (when
focus is in the drop-down list)

Tab / Shift+Tab

Move up/down a row in the lookup Up arrow / Down arrow

Move up/down a page in the lookup Page up / Page down

Move to the top/bottom of the lookup Home / End

Task recorder shortcuts

TO  DO  T H ISTO  DO  T H IS P RESSP RESS

Stop the recording (while recording) Alt+R,S

Toggle the visibility of the Task recorder pane (while
recording)

Alt+R,T

Toggle Rails mode (while playing a task guide) Alt+R,L

Go to the previous step (while playing a task guide) Alt+R,P

Go to the next step (while playing a task guide) Alt+R,N



Toggle focus between the page and the animated pop-up
prompt (while playing a task guide)

Alt+R,F

Expand/collapse the animated pop-up prompt (while playing
a task guide)

Alt+R,C

Show more/less information in the animated pop-up prompt
(while playing a task guide)

Alt+R,M

TO  DO  T H ISTO  DO  T H IS P RESSP RESS

Additional resources

NOTENOTE

Keyboard shortcuts for missing account analysis

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/finance/general-ledger/financial-reporting-keyboard-shortcuts
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Change the banner or logo
2/18/2021 • 2 minutes to read • Edit Online

NOTENOTE

The following procedure lists the steps that system administrators can use to update the banner or logo image

that is displayed for a legal entity. The demo data company used to create this procedure is USMF.

1. Go to Navigation pane > Modules > Organization administration > Organizations > LegalNavigation pane > Modules > Organization administration > Organizations > Legal

entitiesentities .

2. In the list on the left, select the legal entity for which you want to update the banner or logo. If it is already

selected, go to the next step.

3. Expand Dashboard imageDashboard image tab.

4. Select ChangeChange.

The ideal resolution for a banner image is 1920 x 281 pixels. The ideal width for a logo image is 350

pixels.

5. Select SaveSave.

6. Go to Navigation pane > Modules > Common > Common > Default dashboardNavigation pane > Modules > Common > Common > Default dashboard. You should see

the new banner or logo image on the dashboard.

You may need to change your company, using the company picker, to the one you uploaded the banner

for.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/tasks/change-banner-or-logo.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Navigation search
2/18/2021 • 2 minutes to read • Edit Online

NOTENOTE

Quickly navigate to a particular page

This topic explains how to use the search functionality to navigate to pages.

The application includes a number of areas and pages to help you perform various tasks. To quickly find the

pages that you need to complete your tasks, use the navigation search feature.

To use this feature, click the SearchSearch icon to display the SearchSearch box. You can then type one or more words in the

box. The system instantly searches for relevant pages in the application that match the words that you entered.

For example, you could type "vendor invoice" as the input, and then the system displays results that match that

input.

The SearchSearch box helps you find and navigate to pages. It will not help you find specific data or actions.

[

The navigation search feature also serves as a great way for you to quickly navigate to a particular page. For

example, if you are an accounts payable clerk who frequently uses the Payment journalPayment journal  page, you could enter

"payment journal" in the SearchSearch box. Because the input is an exact match for the page title, the page is listed at

the top of the search results, and you can quickly navigate to it.

The search results list displays the page title as well as the navigation path. This shows the location of the page

in the application. It also helps you differentiate between two or more similar pages in the results.

When you search for a page, your input is matched against the page title, as well as its navigation path. For

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/navigation-search.md


Quickly navigate to a page based on the technical form name

Administration and security

Development

NOTENOTE

example, if you enter "receivable" in the SearchSearch box, you will see results for the pages available to you in the

Accounts receivable area – even though the page titles do not include the word "receivable."

The navigation search functionality also includes a much-requested feature for power users: the ability to

quickly navigate to a page based on the technical form name. Many users are so familiar with the system that

they know the exact form names they work with. If you are one of these users, you can enter form:form: followed by

the name of the form you are looking for. For example, if you enter form: vendinvoiceform: vendinvoice, the search results will

show all pages where the form name starts with vendinvoicevendinvoice.

From an administration and security perspective, the navigation search functionality only surfaces two types of

results:

Pages that are enabled in the current configuration (via configuration keys).

Pages that the user has access to based on the user's role.

The list of search results is limited to 10 items. If you do not find what you're looking for in the results, you

should try refining or updating the input.

From a development perspective, the navigation search functionality is easy to leverage because there is

virtually no delay between the deployment of menu items and their ability to show up in search results. As long

as the menu items are linked to from either the navigation pane or the dashboard, they will automatically

become searchable.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Personalize the user experience
2/18/2021 • 22 minutes to read • Edit Online

System-wide options for the current user

NOTENOTE

Restricted personalization access (formerly implicit personalizations)

This topic explains how you can personalize the app and covers the following subjects:

System-wide optionsSystem-wide options  – These personalization options are made on a setup page and are available to all

users. Examples include the color theme and time zone.

Restr icted personalization accessRestr icted personalization access  – At this access level, user actions that are associated with typical page

usage are automatically saved by the app and restored the next time that you visit the page. For example, the

app stores the width of grid columns if you adjust them, and the expanded or collapsed state of FastTabs.

Full personalization accessFull personalization access  – At this access level, users have access to all personalization capabilities in

the app. In particular, they have access to the PersonalizationPersonalization toolbar.

Sharing personalizationsSharing personalizations  – Users who have full personalization access can export their page

personalizations and share them with other users.

Administration of personalizationsAdministration of personalizations  – Privileged users can access the PersonalizationPersonalization administration

page to manage all personalizations at an organizational level.

The User optionsUser options  page contains several system-wide settings for the current user. These options are available

to all users, even users who haven't been given any access to personalization. To open the User optionsUser options  page,

select the SettingsSettings  button on the navigation bar, and then select User optionsUser options . The User optionsUser options  page has

four tabs that contain various user settings:

VisualVisual  – Select a color theme and the default size of elements on pages.

PreferencesPreferences  – Select default values that are used every time that you open the system. These values include

the default company, the initial page, and the default view/edit mode. (The view/edit mode determines

whether a page is locked for viewing or opened for editing every time that you open it.) This tab also

includes options for the language, the time zone, and date, time, and number formats. Finally, this tab

includes several miscellaneous preferences that vary from release to release.

AccountAccount – View or adjust your user name and other account-related options.

WorkflowWorkflow  – Select workflow-related options.

In addition to changing your user settings, you can also view and delete your usage data and personalizations

from the User optionsUser options  page. To see your usage data, select Usage dataUsage data on the Action Pane. On the

PersonalizationPersonalization tab, you can view and manage the personal changes that you've made to pages in the system.

On this tab, you can also reset feature callouts (that is, the pop-up windows that introduce new system features).

You will then be alerted again about previously encountered features.

If the Saved views feature is turned on, you can view and manage your personalizations by selecting PersonalizationPersonalization on

Action Pane on the User optionsUser options page.

At the restr icted personalization accessrestr icted personalization access  level, user actions that are associated with typical page usage are

automatically saved by the app and restored the next time that you visit the page. No explicit save action is

required.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/personalize-user-experience.md


Full personalization access (formerly explicit personalizations)

Here is a list of the actions that fall under typical page usage and are covered by restricted personalization

access:

Grid column widthsGrid column widths  – You can adjust the width of a column in a grid by selecting the sizing bar to the left

or right of the column header, and then sliding it left or right until the column is the desired width. The app

stores the width that you set for a column. Then, the next time that you open that page, the column will be

resized to that width.

Grid footer and column totalsGrid footer and column totals  – (Available only when the new grid control is turned on) You can decide

whether a total should be shown at the bottom of any numeric column in a grid, and whether the grid footer

should be visible. The app stores these preferences and applies them the next time that you open the page.

For more information, see Grid capabilities.

FastTabsFastTabs  – Some pages have expandable sections that are known as FastTabs. The app stores information

about the FastTabs that you've expanded or collapsed. The next time that you open the page, the same

FastTabs will be either expanded or collapsed, based on your last interaction with the page. In some cases,

you can help improve system performance by collapsing a FastTab, because the app doesn't have to retrieve

the information for FastTabs until they are expanded. As is explained later in this topic, you can also change

the order of the FastTabs on a page.

FactBoxesFactBoxes  – Some pages have a Related informationRelated information pane that shows read-only information that is

related to the current subject of the page. Each section in the Related informationRelated information pane is known as a

FactBox. You can expand or collapse the Related informationRelated information pane, and you can also expand or collapse

individual FactBoxes. The app stores these preferences. The next time that you open the page, the RelatedRelated

informationinformation pane and the individual FactBoxes will be either expanded or collapsed, based on your last

interaction with the page. In some cases, you can help improve system performance by collapsing the

Related informationRelated information Pane or a FactBox, because the app doesn't have to retrieve the information for

FactBoxes until they are expanded.

Action PanesAction Panes  – An Action Pane appears near the top of most pages. The Action Pane contains buttons for

many of the actions that you can perform on the current page. These buttons are often organized on tabs.

You can pin the whole Action Pane open, or you can have it collapsed by default. The next time that you open

the page, the Action Pane will be either open or collapsed, based on your last interaction with the page. If you

pinned the Action Pane open, the last tab that you were using will be shown.

QuickFiltersQuickFilters  – A QuickFilter appears above many grids. The QuickFilter lets you filter the grid based on a

single column that you select. The app stores the column that you filtered on. Then, the next time that you

open that page, the grid will use that same column for filtering by default. However, you can still select a

different column to filter the grid on.

Column header filtersColumn header filters  – When you filter a grid by using column header filters, you can change the filter

operator as you require to find the data that you want. For example, you can change the operator from

begins withbegins with to is exactlyis exactly . Every time that you use a column header filter and change the filter operator, the

app stores the change. Then, the next time that you filter on that column, the filter operator will be restored.

Navigation paneNavigation pane – You can open the navigation pane by selecting the Expand the navigation paneExpand the navigation pane

button in the upper left of any page. (This button is sometimes referred to as the MenuMenu button, hamburger,

hamburger menu, or hamburger button.) You can pin the navigation pane open, or you can have it collapsed

by default. After you pin the navigation pane open, the app will keep it open until you collapse it.

At the full personalization accessfull personalization access  level, users have access to all the personalization capabilities that the app

provides. Because different people and companies have different needs when they interact with the app,

especially in terms of utilized fields, personalization provides tools that let users and organizations tailor the way

that information is ordered and interacted with in the app. These capabilities are key to providing simplified,

optimized experiences in the app that are tailored to you and your organization.

If the Saved views feature is turned on, an explicit save is required to persist these changes to the user



Shortcut menu optionsShortcut menu options

The Personalization toolbarThe Personalization toolbar

experience for a specific view. When the Saved viewsSaved views  feature is turned off, these changes are automatically

saved.

The following sections cover the extent of personalization capabilities that are available to users at the fullfull

personalization accesspersonalization access  level. Here are some of these capabilities:

Shortcut menu options

The PersonalizationPersonalization toolbar

Adding tiles, lists, and links to workspaces

Adding a summary from a workspace to a dashboard

Personalizing the dashboard

Shortcut menus provide one way to change a page's interface so that it better meets your requirements or the

requirements of your organization. (A shortcut menu is also known as a right-click menu or a context menu.)

Some of the most typical and important changes that can be made to a page are available directly as options on

a shortcut menu. For example, if you want to add or hide columns in a grid, just right-click a column header, and

then select Inser t columnsInser t columns  or Hide this columnHide this column.

Additionally, the most basic types of personalizations are available by right-clicking an element and then

selecting PersonalizePersonalize. (Note that not all elements on your page can be personalized.) When you use this

personalization method, the element's property window appears.

You can use the property window to personalize an element in the following ways:

Change the element's label.

Hide the element so that it isn't shown on the page. The data in the field isn't deleted or modified. The

information just isn't shown on the page any longer.

Include the information in the FastTab's summary section (if the element is on a FastTab).

Skip the field so that it never receives focus when you tab through the page.

Prevent data in the field from being edited (for any record).

Designate a field to be required for data entry. If no value has been entered in this field, it will appear with a

red border and an asterisk to indicate this state. This option is only available starting in version 10.0.11 when

the Saved views and Designate fields as required using personalizationDesignate fields as required using personalization features are turned on.

The property window might include other personalization capabilities, depending on the element. For example,

the property window for a tile might let you promote that tile to a dashboard, and property windows for

elements on the default dashboard might let you create a new custom workspace.

If you want to make multiple changes to a page, or changes that aren't available through other mechanisms (for



Navigating the pageNavigating the page

Personalization toolsPersonalization tools

example, if you want to reorder elements), you can use the PersonalizationPersonalization toolbar. To open the

PersonalizationPersonalization toolbar, follow one of these steps:

Select Ctr l+Shift+PCtr l+Shift+P from any element on the page.

Select Personalize this pagePersonalize this page in an element's property window.

Select Personalize this pagePersonalize this page in the PersonalizePersonalize group on the OptionsOptions  tab of any page's Action Pane.

Select the SettingsSettings  button (the gear symbol) on the navigation bar, and then select PersonalizePersonalize.

When the PersonalizationPersonalization toolbar is open, the underlying page is read-only (in other words, you can't edit

data), but it's still interactive. Specifically, you can expand or collapse the Related informationRelated information pane, switch

tabs, and expand or collapse sections, just as you would usually perform those actions on the page. To apply a

personalization to a collapsible section or tab (for example, to hide a FastTab), you just have to select the button

that appears next to that section or tab when it gains keyboard focus or when you hover over it.

The following tools are available on the PersonalizationPersonalization toolbar :

Use the SelectSelect tool to select and change the properties of an element. To use this tool, select the SelectSelect

button on the toolbar, and then select the desired element. The element's property window appears,

where you can change any of the properties of that element. You can repeat the process for other

elements that can be personalized on the page. Note that some personalization properties might not be

available in some scenarios. For example, you can't lock a field that is required.

Use the HideHide tool to hide an element on the page. To use this tool, select the HideHide button on the toolbar,

and then select the element to hide. When you use the HideHide tool, all elements that are currently hidden

are made visible, but they are shown in a shaded container. You can then make an element visible by

selecting it. To see how the page will look when elements are hidden, switch to another personalization

tool or close the personalization toolbar.

Use the Add fieldsAdd fields  tool to add fields to your page. When you use this tool, you can add only fields that

are part of the page definition. For information about how to create new fields that aren't part of the

current page definition, see Create and work with custom fields. After you select the Add fieldsAdd fields  button

on the toolbar, you must first select the grid or section where you want to add a field. A dialog box will

show the list of fields that are related to the selected grid or section. In the dialog box, select one or more

fields to add, and then select UpdateUpdate. To remove a field that you previously added, repeat the process,

but clear the selection of the field in the dialog box.

Use the MoveMove tool to move an element to a different location in the current group of elements. Note that

you can't move an element outside its parent group. To use this tool, select the MoveMove button on the

toolbar, and then select the element to move. When you select an element, the app determines the

locations where the element is allowed to be moved. These locations are known as drop zones. As you

drag the element around in the current group, each drop zone is shown as a colored, bold line next to the

area where the element can be dropped.

Use the SkipSkip tool to remove an element from the page's keyboard tab sequence. When you select the

SkipSkip button on the toolbar, all elements that are currently skipped are shown in a shaded container. You

can interactively remove or add fields to the tab sequence.

Use the Show in headerShow in header  tool when you want a field to appear in the FastTab's summary section. When

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/media/restyledpersonalizationtoolbar.png


  Adding tiles, lists, and links to a workspaceAdding tiles, lists, and links to a workspace

you select the Show in headerShow in header  button on the toolbar, all fields that have been selected as summary

fields are shown in a shaded container. You can interactively add fields to the FastTab summary and

remove fields from the summary by selecting the fields.

Use the RequireRequire tool to designate an element as required for data entry. When you select the RequireRequire

button on the toolbar, all elements that have been personalized to make them required are shown in a

shaded container. You can then make them not required again. This option is available in version 10.0.12

and later when the Designate fields as required using personalizationDesignate fields as required using personalization feature is turned on.

Use the LockLock tool to mark an element as either editable or noneditable. When you select the LockLock button

on the toolbar, all elements that are currently noneditable are shown in a shaded container. You can then

make them editable again. Note that some fields are required and can't be made noneditable. A padlock

symbol appears next to those fields.

Use the Add an app from Power AppsAdd an app from Power Apps  tool to embed an app that was created by using Microsoft

Power Apps into the page. For detailed information about how to embed an app from Power Apps into a

page, see Embed apps from Power Apps. This option is available only when the Saved views feature is

turned off.

Use the Add an appAdd an app button to embed an app, either one created from Microsoft Power Apps or a third-

party, into the page. This option is only available when the Saved views feature is turned on.

Use the ClearClear  tool to reset the page to its default, installed state. All personalizations on the current page

will be cleared. You can't undo this action. Therefore, use this tool only if you're sure that you want to

reset the page. When the Saved viewsSaved views  feature is turned on, this tool clears the personalizations for the

current view.

Use the Impor tImpor t tool to load a personalization from a file that you or someone else previously created.

When the Saved viewsSaved views  feature is turned off, you can choose whether to add or replace your existing

personalizations with the personalizations that are being imported for the page. You can't undo this

action. Therefore, after you import personalizations, you must manually clear or undo any changes

that you don't want.

When the Saved viewsSaved views  feature is turned on, the imported personalizations will become a view on the

page. If the view already exists, you will have the option to skip the import, replace the current view

that has the same name, or rename the imported view.

Use the Expor tExpor t tool to save your personalizations for the page to a file. You can then share your

personalizations with other users. Those users just have to import the file that contains your

personalizations for the page. When the Saved viewsSaved views  feature is turned on, this tool saves your current

view to a file for sharing.

Select the CloseClose button to close the PersonalizationPersonalization toolbar and return the page to its previous

interactive state.

Traditionally, when the PersonalizationPersonalization toolbar is used, your personalizations take effect as soon as you make

them. However, if the Saved views feature is turned on, you must explicitly save personalizations to a view that

you choose.

In some cases, when you select a tool, a padlock symbol appears next to an element. This symbol indicates that

you can't modify the element properties that are related to the selected tool, because changes to those

properties will prevent the page from working correctly.

For some pages that include lists, the Add to workspaceAdd to workspace personalization feature is available in the

PersonalizePersonalize group on the OptionsOptions  tab of the Action Pane. This feature lets you push relevant information from

the current list to a specific workspace. The information that appears in the workspace can be based on either
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Adding a summary from a workspace to a dashboardAdding a summary from a workspace to a dashboard

the whole list, or a filtered and sorted version of the list. You can also specify whether the information appears in

the workspace as a list, a summary tile that can show the number of items in the list, or a link.

If the Saved views feature is turned on, the content that you push to a workspace is directly linked to a view. The view's

query is used to retrieve data into the workspace, and the corresponding tile or link in the workspace opens the page to

that view, so that the view's query and personalizations are applied to it. If the view is updated, the corresponding

workspace elements will be adjusted to the new view definition.

To add a list to a workspace, first sort or filter the list on the page so that it shows the information as you

want it to appear in the workspace. (If the Saved viewsSaved views  feature is turned on, you can't continue until you

save a view that has these conditions.) Then select Add to workspaceAdd to workspace. Select a workspace, and then, in the

PresentationPresentation field, select L istL ist. After you select ConfigureConfigure, a dialog box appears, where you can select the

columns that should appear in the list in the workspace. You can also specify the label that is used for the list

in the workspace.

To add a tile to a workspace, first filter the list on the page so that it shows the data that should be

summarized or that you want quick access to. (If the Saved viewsSaved views  feature is turned on, you can't continue

until you save a view that has these conditions.) Then select Add to workspaceAdd to workspace. Select a workspace, and

then, in the PresentationPresentation field, select TileTile. After you select ConfigureConfigure, a dialog box appears, where you can

specify the label that should be used for the tile in the workspace. You can also specify whether the tile

should show a count. After the tile is added to the workspace, you can select it to open the current page from

the workspace. You can then view the filtered list that is associated with the tile.

To add a link to a workspace, first filter the list on the page so that it shows the data that you're interested in.

(If the Saved viewsSaved views  feature is turned on, you can't continue until you save a view that has these conditions.)

Then select Add to workspaceAdd to workspace. Select a workspace, and then, in the PresentationPresentation field, select L inkLink . After

you select ConfigureConfigure, a dialog box appears, where you can specify the label that should be used for the link.

You can also optionally specify a label for a new section that contains this link.

After you've added a list, tile, or link to a workspace, you can open that workspace and rearrange the elements in

it as you want.

Some workspaces contain count tiles (that is, tiles that have numbers on them), and you might want those tiles

to appear on your dashboard too. In a workspace, right-click a count tile, select PersonalizePersonalize, and then, in the

tile's property window, select Pin to dashboardPin to dashboard. The next time that you open and refresh the dashboard, the

count will appear below the navigation tile for that workspace. You can select that count to go directly to the

data that it represents.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/media/personalization-addtoworkspace.png
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WARNINGWARNING

Sharing personalizations

Administration of personalizations

The dashboard is often the first page that you see when you open the app. It can be personalized like any other

page in the system, by using the same mechanisms that are described earlier in this topic.

Currently, when you hide content on the dashboard, it's important that you directly target a tile, not the space around it.

If you hide the group around a tile, there could be unexpected results if more tiles are added later, or if the system is

switched to a different language.

One unique personalization capability that is available on the dashboard is the ability to add tiles.

If the Full-page appsFull-page apps  feature is turned off, you add a new tile by right-clicking an element on the dashboard

and then selecting Add a workspaceAdd a workspace. A new workspace tile is created at the bottom of the dashboard. You

can rename this new workspace tile as you want. You can also add lists, tiles, and links to the workspace, as

described in the Adding tiles, lists, and links to a workspace section of this topic.

If the Full-page appsFull-page apps  feature is turned on, you add a new tile by right-clicking an element on the dashboard

and then selecting Add an appAdd an app. In the dialog box, select whether you want to add a tile for a new workspace

or a tile that has content from Power Apps or a website. Then follow the steps to configure the option that

you selected. A new tile is created at the bottom of the dashboard.

After you personalize a page, you can share your personalizations with other users by exporting the

personalized page. You can then ask other users to import the personalization file. Alternatively, you can give

your personalizations to a user who has admin privileges. That user can then apply your personalization file to

many users at the same time by using the PersonalizationPersonalization administration page.

The PersonalizationPersonalization page is the central hub for managing personalizations at an organizational level. The

content and capabilities on this page depend on whether the Saved viewsSaved views  feature has been turned on.

For customers who have turned on the Saved viewsSaved views  feature, see the "Managing views globally" section in the

Saved views topic.

For customers who haven't yet turned on the Saved views feature, this page has four tabs:

ApplyApply  – You can import or select a personalization for one or more users. To apply a personalization to one

or more users, first select a role and users who have that role. Then either select an existing personalization

to apply to the selected users, or import a personalization file. The personalization is validated and will be

applied to all the selected users the next time that they open the selected page.

ClearClear  – You can clear all personalizations for a page or workspace for one or more users. First select a page

or workspace to see a list of the users who have personalized it. Then select the users who should have

personalizations for that page or workspace cleared, and select ClearClear . All personalizations that the selected

users have applied to the selected page or workspace are deleted. This action can't be undone. However, if a

personalization was saved for the page or workspace, that personalization can be reimported.

UsersUsers  – Select a user to see a list of the pages that the user has personalized. You can then turn that user's

ability to use personalizations for specific pages, or for the whole system, on or off. You can also import,

export, or clear a personalization for the user. In addition, you can reset feature callouts for the user. In this

case, if the user previously dismissed any pop-up windows that introduce new features, they will appear

again the next time that the user encounters those features.

SystemSystem – You can temporarily turn off personalization for all users in the system. In this case, all
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personalizations are deleted for all users, and all pages are reset to their default state. If you turn

personalization back on later, all personalizations are reapplied. You can also permanently delete all

personalizations for all users in the system. Personalizations that have been deleted can't be recovered.

Therefore, before you perform this task, be sure to export any personalizations that you might want later.

When you personalize the setup of inventory dimensions on a page, consider the settings that have been

created by using the Display dimensionDisplay dimension option. For example, you use personalization to hide a column for the

Batch number inventory dimension, but the column appears the next time that the page is opened. This

behavior occurs because the Dimension displayDimension display  settings control the inventory dimension columns that are

shown. The Dimension displayDimension display  settings apply across all pages and override any personalized setup of

inventory dimension fields on individual pages.

Therefore, in the preceding example, if you don't want the column for the Batch number inventory dimension to

appear on a page, you must clear that dimension as part of the Display dimensionsDisplay dimensions  option for that page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

Introduction

Switching between views

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see Service update availability.

Personalization plays an important role in allowing users and organizations to optimize the user experience to

meet their needs. For more details on personalization, see Personalize the user experience.

Traditional personalization let users have only one set of personalizations per page. The Saved viewsSaved views  feature

expands on personalization in several important ways:

Views permit users to have multiple named sets of personalizations per form, which they can quickly switch

between as needed. This allows a user to create multiple optimized views of a page, where each view has

been tailored to fit the needs of performing a particular business task.

Views created for particular page types can also include user-added filters or sorts, which allows users to

quickly return to commonly filtered datasets. See the What pages support views section for more details.

Views can be published to users in specific security roles and specific legal entities. Therefore, any user who

has a specified role and access to a specified legal entity can access and use that view, even if that user

doesn't not have permission to personalize. This publish capability lets organizations define corporate,

standard views that are optimized for their business. For more information, see the Managing

personalizations at an organizational level with views section.

Unlike traditional personalization, views aren't automatically saved when a user performs personalizations or

filters a list. Explicit saves are required to give users the flexibility to create a view before or after the changes

that are associated with that view have been made. This requirement also ensures that view definitions aren't

unintentionally changed by filters or personalizations that aren't intended for long-term use. Items that the

system automatically stores as part of typical page usage (for example, column widths, or the expanded or

collapsed state of sections) will be saved per view.

Views can be added to workspaces as tiles, lists, or links. Therefore, a filtered data set can be surfaced in a

workspace, and users can associate a set of personalizations that is relevant to that data set with a tile or link.

After views have been made available for an environment, the top of any page that supports views will include a

collapsed view selector control that shows the name of the current view.

There are two size variations to the view selector :

Large view selectorsLarge view selectors  – Pages that prominently feature a list will have a larger view selector for a few

reasons. Most importantly, the larger view selector indicates the pages where the view can include user-

defined filters. Because filters are included in the views, the larger selector size is also warranted as the view

names will often be the best description of the data shown on the screen and the expectation is that users

will switch between views more often on these page types.

Small v iew selectorsSmall v iew selectors  – All other full-screen pages (except workspaces and the dashboard) have a smaller

view selector that appears next to the page caption. Views on these pages include only personalizations, not

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/saved-views.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/public-preview-releases
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user-defined filters. On these pages, the caption or record title is often the most important information at the

top of the page. The smaller size of the view selector also reflects the lower frequency of view switching that

is expected on these pages.

If you select the view name, the view selector is opened and shows the list of available views for the page.

Standard viewStandard view  – The StandardStandard view is the out-of-box view of the page, where no personalizations are

applied.

Personal viewsPersonal views  – The views without padlocks represent your personal views. These are views that either

you have created or that an administrator has given to you.

Locked viewsLocked views  – Some views (such as the StandardStandard view and any views that are published to your role)

have a padlock symbol next to them in the view selector. This symbol indicates that you can't edit those

views. However, changes that reflect page usage are automatically saved. These changes include changes to

the width of a grid column, and changes to the expanded or collapsed state of a FastTab. Nevertheless, if you

have personalization privileges, you can use the Save asSave as  action to make a personal view that is based on a

locked view.

New viewsNew views  – Published views that haven't yet been opened have a spark symbol to the left of the view

name.

To switch to a different view, first open the view selector and then select the view that you want to load.

Unlike traditional personalization, views aren't automatically saved when a user personalizes the page, or when

a user applies a filter to a list or sorts it. An explicit action is required to save these changes to a view. This

requirement gives users the flexibility to create a view before or after the changes that are associated with that

view have been made. It also ensures that view definitions aren't unintentionally changed by one-time filters or

personalizations. Note that typical page usage items (for example, column widths, or the expanded or collapsed

state of sections) are automatically saved to the current view, even for locked views.

To ensure that the current state of the view is known, when you start to change a view by personalizing or

filtering it, an asterisk (*) appears next to the current view name. This symbol indicates that you're looking at an

unsaved, modified version of that view.

If you want to save those changes, follow these steps.

1. Select the view name to open the view selector.

2. To modify the existing view, select SaveSave. Note that this action isn't available for locked views.

3. To create a new view:

a. Select Save asSave as .

b. Enter a view name and (optionally) a description.

c. Select SaveSave.

The default view is the view that the system tries to open when you first open the page. You should set the

default view to the view that you expect to use most often.

There is a single, global default view across companies. If you change the default view, that view will be opened by default,

regardless of the legal entity that you're currently in.
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Managing personalizations at an organizational level with views

To change the default view for a page, follow these steps:

1. Switch to the view that you use as the default.

2. Select the view name to open the view selector.

3. Select MoreMore and then Pin as defaultPin as default.

Alternatively, when you create a new view (by using the Save asSave as  action), you can make that new view the

default view by setting the Pin as defaultPin as default option before you save the view.

Note that, in some cases, the query that is associated with the default view isn't run when you first open a page.

For example, if you open the page through a tile, the tile's query will be run, regardless of the query that is

associated with the default view. Additionally, if you open a page that has a StandardStandard view that already has a

defined query, the original query will be run instead of the default view's query. In this case, you will receive an

informational message when the view is loaded. If you switch views after the page has been loaded, the view

query should be able to be run as expected. In version 10.0.10 and later, the informational message that you

receive will have an embedded action that lets you load the default view's query directly.

The Manage my viewsManage my views  dialog box gives you basic maintenance capabilities over your personal views and the

order of views in the view selector. To open this page, select the view name to open the view selector drop-down

menu, select MoreMore, and then select Manage my viewsManage my views .

For a list of available views for that page, the following set of actions are available.

Change the default viewChange the default view  – Use the Pin as defaultPin as default action to make the currently selected view the default

view for this page.

Reorder your viewsReorder your views  – Use the Move upMove up and Move downMove down actions to rearrange your views in a specific

order.

Rename a viewRename a view  – Use the RenameRename action to change the name of the currently selected personal view. This

action is turned off for locked views.

Delete a viewDelete a view  – Use the DeleteDelete action to permanently delete the currently selected view from the page.

There is no way to recover a view after you remove it.

Any changes made in this dialog box will take effect after you select the SaveSave button.

To help you understand how saved views help improve management of personalizations at an organizational

level, this section describes some differences in personalization management with and without the SavedSaved

viewsviews  feature.

Without views, administrators would apply a set of personalizations for a page to a user or a group of users via

the Personalization page. If those users had personalization rights, the personalizations would be applied to that

page. However, there was no ability to prevent users from further personalizing the page, which meant the

organization could not ensure that its users had a consistent user interface. If any of those users didn't have

personalization rights, the personalizations given to them by an administrator were not loaded. Further, if new

users were hired into an organization, administrators needed to manually load a set of personalizations for the

user. There was no automatic mechanism for specifying that a certain set of personalizations should be available

for users in that role.

The Saved viewsSaved views  feature makes organizational management of personalizations much easier, primarily

because views can be published to groups of users. After a view has been published, any user who has one of

the defined security roles and access to one the specified legal entities can see and use the view, even if that user

doesn't have access to personalization. Although every user has a copy of the published view, where page usage
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items are automatically applied, no user can save personalizations or query updates to a published view. In

other words, published views are locked. Additionally, if new users are assigned to roles in legal entities that

views were published to, they will automatically see the views that are associated with their roles and legal

entities. No additional action is required by the admin. Likewise, if users change roles in an organization or are

given access to different legal entities, they might no longer be able to access the views that were previously

published to them. Again, no additional action is required by the admin.

Updates to a published view can easily be distributed to users by republishing the view to the appropriate

security roles and legal entities.

The publish capability allows organizations to define corporate standard views that are optimized for their

business, targeted at users in specific security roles.

During the publishing process, views can be assigned to one or more security roles for one or more legal

entities. Therefore, any user who has access to a legal entity and is assigned to one of those roles can access and

use the views. However, the user can't edit the views. By default, system admins have access to the PublishPublish

action in the view selector drop-down menu. However, other trusted users in your organization can also be

given access to view publishing via the new Saved views administratorSaved views administrator  role.

To publish a view, follow these steps:

1. Create and save a personal copy of the view that you want to publish.

2. With that view currently loaded, select the view name to open the view selector drop-down menu.

3. Select the MoreMore button and then select PublishPublish . The Publish dialog box will open.

4. Enter a name for the view. The name that you enter is the name that users who receive this view will see in

their view selectors. The names of published views for a page must be unique. No duplicate names are

allowed, even if the list of roles or legal entities that the views are applied to differ.

5. Update 10.0.17 or later :Update 10.0.17 or later : If the (Preview) Translation suppor t for organization views(Preview) Translation suppor t for organization views  feature is

turned on, you can add translations for your view name in as many languages as your organization requires

by selecting the TranslationsTranslations  button next to the NameName field. The view name will then be shown to users in

their current language. You can also set the default language to specify the translation that will be shown to

users who are running languages that no translation is defined for.

6. Optional: Enter a description for the view, so that users who receive this view can better understand its

purpose.

7. Determine whether the view should be published as the default view for the selected users. When a view is

made the default view, users will see it the next time that they open the target page. The single, global default

view of every targeted user will be changed. However, users can still change their default view after

publishing has occurred.

8. Add the security roles that correspond to the users who are being targeted by this view.

9. Determine whether you want to publish the view to the child roles of each security role that is selected. If you

do, select the Include child rolesInclude child roles  check box in the row for the appropriate security roles. Note that this

check box isn't available for roles that don't have child roles.

10. Add the legal entities that this view should be available for.

11. Select PublishPublish .

Note that in some environments, it may take some time (up to an hour) before users see the published view.
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Modifying a published view

Managing published views

Be aware of the following expectations when you publish a view to a legal entity, or when you publish a view as the

default view.

If you publish a view as the default view to all or some legal entities, you change the single, global default view of

every targeted user. If a user has roles where multiple views are published as the default view, the last view that was

published will be used as the user's default view.

If you publish a view to a legal entity, but you don't publish it as the default view, users will initially see the view in the

view selector only for the specified legal entities. However, after the view is loaded for the first time, it will always be in

the user's view selector for that page, regardless of the legal entity.

After you publish a view, you might find that you want to change it. Although you can't make live changes to a

published view, because these views are locked for editing for all users (including publishers), you can republish

a view to update it.

If the changes that you want to make to a published view only involve the publish parameters (the name and

description of the view, or the security roles the view is published to), do the following:

1. Switch to the published view for the parameters that you want to update.

2. On the view selector drop-down menu, select RepublishRepublish . If you're using version 10.0.12 or earlier, you must

select PublishPublish and then YesYes  to update the existing view.

3. Update the name, description, security roles, and legal entities for the view.

4. Select PublishPublish . If you originally selected this published view as the default view, it will be the default view for

users again after you republish it.

If the changes to the published view involve modifications of the personalizations or filters that are associated

with the view, follow these steps.

1. Load the published view that you want to change.

2. Make the required changes to the local draft.

3. On the view selector drop-down menu, select RepublishRepublish .

4. Select YesYes  to indicate that you want to publish the view together with its unsaved changes.

5. Adjust any publishing parameters that require adjustment, and then select PublishPublish .

Like managing personal views, the Manage my viewsManage my views  dialog box gives users with publish privileges basic

maintenance capabilities over that page's published views (in addition to their own personal views). To open this

page, select the view name to open the view selector drop-down menu, select MoreMore, and then select ManageManage

my viewsmy views .

Although all users have a My viewsMy views  tab that show their personal views, users who have publish privileges also

have an Organization viewsOrganization views  tab that shows all the published and unpublished views for that page. Because

several users might be publishing views, it's important that you be able to manage the full list of published

views, even if you aren't the user who published a given view.

For the list of all published views for the page, the following set of actions are available.

RepublishRepublish – Use the RepublishRepublish action to republish a view after publishing parameters (name, description,

security roles, or legal entities) are changed.

PublishPublish – Use the PublishPublish action to publish a view that is currently unpublished.
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Known issues

Frequently asked questions
How do I enable saved views in my environment?How do I enable saved views in my environment?

UnpublishUnpublish – Use the UnpublishUnpublish action to make a view inactive. The view will still be available in the system,

but users won't see it in the view selector until the view is published again.

Save as personalSave as personal  – Use the Save as personalSave as personal  action to create a personal draft copy of the published view.

This capability can help you understand the contents of a view that wasn't published to you or that hasn't yet

been published. You can also use it to edit and then republish a view.

DeleteDelete – Use the DeleteDelete action to permanently delete a published or unpublished view. This action also

removes the view for all users in the system. The removal of published views takes effect after the SaveSave

button is selected. After a view is deleted, it can't be recovered.

Although some management capabilities are surfaced on every page, as indicated in this topic, systemsystem

administratorsadministrators  and saved view administratorssaved view administrators  can manage views more holistically for the system via the

PersonalizationPersonalization page. In particular, this page has the following sections and capabilities:

Published viewsPublished views  – This section lists all views that have been published for your organization. From here,

you can republish a view after you adjust the security roles or legal entities that the view targets. You can also

export, delete, or unpublish views. You can use the Save as personalSave as personal  action to create a personal copy of a

view, so that you can update the view or gain a better understanding of its contents.

Unpublished viewsUnpublished views  – This section lists all the organization views in your system that aren't currently

published. These views most often come into the system through the import capability. You can publish,

export, or delete these views. The Quick publishQuick publish action that was added in version 10.0.12 enables multiple

views from this section to be published in one action, by using the existing security role and legal entity

configurations. You can use the Save as personalSave as personal  action to create personal copies of these views, so that

you can gain a better understand their contents.

Personal viewsPersonal views  – This section lists all views that have been created by users in the system. From here, you

can publish a personal view to the organization, or copy one or more of these views to other users. You can

also export or delete these views as required.

User settingsUser settings  – Select a user to view, or adjust the user's ability to use personalization either for the whole

system or for specific pages that the user has visited. You can view and interact with the user's

personalizations in the system. You can also delete all personalizations for that user or reset feature callouts

for the user. If feature callouts are reset, any pop-up windows that introduced new features and that the user

previously dismissed will appear again the next time that the user encounters those features.

System settingsSystem settings  – You can temporarily turn off personalization for all users in the system. In this case, no

personalizations are applied for any user, and all pages are reset to their default state. If you turn

personalization back on later, all personalizations are reapplied. You can also permanently delete all

personalizations for all users in the system. Personalizations that have been deleted can't be recovered.

Therefore, before you perform this task, be sure to export any personalizations that you might want later.

Users who have access to the PersonalizationPersonalization page can also import personal or organization views by using

the Impor t viewsImpor t views  button on the Action Pane. For organization views, you can select Publish immediatelyPublish immediately  to

make the views available to users without an additional explicit publish.

For a list of known issues with saved views, please see Build forms that fully utilize saved views.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/user-interface/understanding-saved-views
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What happens to existing personalizations when views are enabled?What happens to existing personalizations when views are enabled?

What pages support views?What pages support views?

Who is allowed to publish views?Who is allowed to publish views?

Why am I not able to save filters with this view?Why am I not able to save filters with this view?

What data will I see when I visit a page?What data will I see when I visit a page?
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The Saved viewsSaved views feature requires the Personalization system in Finance and Operations to be enabled. If personalization

is turned off for the entire environment, views will be disabled even if you follow steps below.

You can turn the Saved viewsSaved views  feature on and off through Feature management in any environment. After it's

turned on, saved views will be enabled in all subsequent user sessions.

When views are enabled, any existing personalizations for a user and form are saved into a new view called MyMy

viewview  that is automatically set as the default view. This is meant to ensure that there is a consistent user

experience before and after views are enabled, except for the view selector control appearing on forms.

Views are available on most, but not all pages. Specifically, views are currently available on all full-screen pages

except for dashboards and workspaces. Non-full-screen pages, which include dialog boxes, drop-down dialogs,

lookups, enhanced previews, currently do not support views. View support for additional page types, such as

workspaces and dialog boxes, may be considered for a future update.

Only system admins and users who have been assigned to the Saved views administratorSaved views administrator  role have the

rights to publish views.

There are a few reasons why a filter may not appear to save with a view:

The page may not support saving filters as part of the view definition. Note that only pages with large view

selectors allow personalizations and query modifications to be saved as a view. See the Switching viewsSwitching views

section for more information.

The page in question may not properly support views, as it may ignore the view query completely or may

operate on a temporary table whose data is not persistent.

For pages that have small view selectors (only personalizations can be saved to the view), you will see the same

data as you always have when you visit the page.

For pages that have large view selectors (both personalizations and queries can be saved to the view), you will

typically see the data that is linked to the query that is associated with your default view. There are two main

exceptions:

If you navigate to a page from a tile, the tile query will execute regardless of the query associated with the

default view. If you created that tile after views have been enabled, selecting a tile will open the page with the

view associated with that tile.

If you navigate to a page and that entry point includes a query, the original query will execute originally in

place of the default view's query. You should be alerted when this occurs via an informational message when

the view is loading. You can also confirm by switching to this view after the page loads, as that should allow

the view query to execute regardless.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Customizing the standard saved views

Available saved views and how to enable them

Saved views for the Inventory management module

PA GEPA GE VIEW  N A M EVIEW  N A M E VIEW  DESC RIP T IO NVIEW  DESC RIP T IO N F EAT URE N A M EF EAT URE N A M E

On-hand list Financials This simplified view lets you
focus on financial
information while you
manage on-hand inventory.

Saved views for Inventory
management

On-hand list Quality control This simplified view lets you
focus on quality control
while you manage on-hand
inventory.

Saved views for Inventory
management

Microsoft Dynamics 365 Supply Chain Management includes several saved views that you can enable and use

as needed. Some of these standard saved views are optimized and named for a specific role or task (for

example, "Quality control" or "Receiving"). Others are optimized so that they include only the fields and settings

that Microsoft usage statistics indicate are most often used by customers. These saved views are typically

referred to as simplified views. This topic describes the standard saved views that are available, and explains

how to enable and customize them.

For complete details about how to work with saved views, including the standard saved views, after you enable

them, see Saved views.

You can customize the standard saved views, just as you can customize your own saved views. However, when

you customize a standard saved view, we strongly recommend that you save your custom version under a new

name. Otherwise, your customizations could be overwritten when you update Supply Chain Management.

For more information about how to customize and rename saved views, see Saved views.

To use the saved views feature, regardless of whether you will use the standard saved views, you must turn on

the Saved views feature in Feature management.

The remaining sections of this topic provide tables that describe the standard saved views that are currently

available for each relevant module. Each table shows the name of each saved view, the page where you can find

it, and a description of it. Each table also shows the name of the feature that includes the saved view. To see a

standard saved view in your system, you must turn on the specified feature in Feature management.

The following table describes the saved views available for the Inventory management module.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/get-started/saved-views-scm.md


On-hand list Receiving This simplified view lets you
focus on receiving
operations while you
manage on-hand inventory.

Saved views for Inventory
management

On-hand list Shipping This simplified view lets you
focus on shipping
operations while you
manage on-hand inventory.

Saved views for Inventory
management

Transactions Simplified This simplified view lets you
review inventory status
without being distracted by
financial information and
other fields that are used
less often.

Saved views for Inventory
management

Transfer orders Shipping This simplified view lets you
focus on shipping
operations while you
manage transfer orders.

Saved views for Inventory
management

Transfer orders Receiving This simplified view lets you
focus on receiving
operations while you
manage transfer orders.

Saved views for Inventory
management

Transfer orders Quality control This simplified view lets you
focus on quality control
while you manage transfer
orders.

Saved views for Inventory
management

Transfer orders Financials This simplified view lets you
focus on financial
information while you
manage transfer orders.

Saved views for Inventory
management
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Saved views for the Master planning module

PA GEPA GE VIEW  N A M EVIEW  N A M E VIEW  DESC RIP T IO NVIEW  DESC RIP T IO N F EAT URE N A M EF EAT URE N A M E

Planned orders: Planned
order details page

Simplified This simplified view includes
only the fields that are most
often used to work with the
details of a single planned
order. In this way, it
provides a quicker overview
and a streamlined work
process.

Saved views for planned
orders

The following table describes the saved views available for the Master planning module.



Planned orders: Planned
orders list page

Simplified This simplified view includes
only the fields that are most
often used to work with the
list of planned orders. In
this way, it provides a
quicker overview and a
streamlined work process.

Saved views for planned
orders

PA GEPA GE VIEW  N A M EVIEW  N A M E VIEW  DESC RIP T IO NVIEW  DESC RIP T IO N F EAT URE N A M EF EAT URE N A M E

Saved views for the Procurement and sourcing module

PA GEPA GE VIEW  N A M EVIEW  N A M E VIEW  DESC RIP T IO NVIEW  DESC RIP T IO N F EAT URE N A M EF EAT URE N A M E

Purchase order details Order creation This simplified view is
optimized for creating new
purchase orders.

Saved views for purchase
orders

Purchase order details Inventory management This simplified view is
optimized for performing
inventory-related activities,
such as following up on
inventory that has been
received, receiving
inventory, checking net
requirements, and adjusting
order quantities.

Saved views for purchase
orders

Purchase order details Financial management This simplified view is
optimized for performing
finance-related activities,
such as invoicing and
checking prices, totals, and
charges.

Saved views for purchase
orders

Purchase order details Order approval This simplified view is
optimized for approving
purchase orders.

Saved views for purchase
orders

Saved views for the Production control module

PA GEPA GE VIEW  N A M EVIEW  N A M E VIEW  DESC RIP T IO NVIEW  DESC RIP T IO N F EAT URE N A M EF EAT URE N A M E

Production order BOM
page

Simplified This simplified view includes
only the fields that are most
often used. In this way, it
provides a quicker overview
and a streamlined work
process.

Saved views for production
control

The following table describes the saved views available for the Procurement and sourcing module.

The following table describes the saved views available for the Production control module.



Production order details
page

Simplified This simplified view includes
only the fields that are most
often used. In this way, it
provides a quicker overview
and a streamlined work
process.

Saved views for production
control

Production order picking list
page

Simplified This simplified view includes
only the fields that are most
often used. In this way, it
provides a quicker overview
and a streamlined work
process.

Saved views for production
control

Production orders list page Simplified This simplified view includes
only the fields that are most
often used. In this way, it
provides a quicker overview
and a streamlined work
process.

Saved views for production
control

PA GEPA GE VIEW  N A M EVIEW  N A M E VIEW  DESC RIP T IO NVIEW  DESC RIP T IO N F EAT URE N A M EF EAT URE N A M E

Saved views for the Sales and marketing module

PA GEPA GE VIEW  N A M EVIEW  N A M E VIEW  DESC RIP T IO NVIEW  DESC RIP T IO N F EAT URE N A M EF EAT URE N A M E

Packing slip journal Journal review This simplified view includes
only the fields that are most
often used to review
packing slip journals.

Saved views for sales and
marketing

Sales order Order creation This simplified view includes
only the fields that are most
often used to create sales
orders.

Saved views for sales and
marketing

Sales order Order review This simplified view includes
only the fields that are most
often used to review sales
orders.

Saved views for sales and
marketing

Sales quotation Quote creation This simplified view includes
only the fields that are most
often used to create sales
quotations.

Saved views for sales and
marketing

Saved views for the Warehouse management module

PA GEPA GE VIEW  N A M EVIEW  N A M E VIEW  DESC RIP T IO NVIEW  DESC RIP T IO N F EAT URE N A M EF EAT URE N A M E

The following table describes the saved views available for the Sales and marketing module.

The following table describes the saved views available for the Warehouse management module.



All loads Inbound processing This simplified view includes
only the fields that are most
often used to process
inbound loads.

Saved views for load
processing

All loads Outbound processing This simplified view includes
only the fields that are most
often used to process
outbound loads.

Saved views for load
processing

All shipments Inbound processing This simplified view includes
only the fields that are most
often used to process
inbound shipments.

Saved views for shipment
processing

All shipments Outbound processing This simplified view includes
only the fields that are most
often used to process
outbound shipments.

Saved views for shipment
processing

All waves Simplified This simplified view includes
only the fields that are most
often used. In this way, it
provides a quicker overview
and a streamlined work
process.

Saved view for wave
processing

Load planning workbench Simplified This simplified view includes
only the fields that are most
often used. In this way, it
provides a quicker overview
and a streamlined work
process.

Saved view for the work
planning workbench

Work details Simplified This simplified view includes
only the fields that are most
often used. In this way, it
provides a quicker overview
and a streamlined work
process.

Saved view for the work
details page

PA GEPA GE VIEW  N A M EVIEW  N A M E VIEW  DESC RIP T IO NVIEW  DESC RIP T IO N F EAT URE N A M EF EAT URE N A M E

NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

Calculating totals

Showing the grid footerShowing the grid footer

Specifying columns with totalsSpecifying columns with totals

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see Service update availability.

The new grid control provides several useful and powerful capabilities that you can use to enhance user

productivity, construct more interesting views of your data, and get meaningful insights into your data. This

article will cover the following capabilities:

Calculating totals

Typing ahead of the system

Evaluating math expressions

Grouping tabular data (enabled separately using the (Preview) Grouping in gr ids(Preview) Grouping in gr ids  feature)

Freezing columns

In Finance and Operations apps, users have the ability to see totals at the bottom of numeric columns in grids. A

footer section at the bottom of the grid shows these totals.

There is a footer area at the bottom of every tabular grid in Finance and Operations apps. The footer can show

valuable information that is related to the data that appears in the grid. Here are some examples of this

information:

The number of selected rows in the table (when you select more than one record)

Grand totals at the bottom of configured, numeric columns

The number of rows in the dataset

This footer is hidden by default but you can turn it on. To show the footer for a grid, right-click on a column

header in the grid and select the Show footerShow footer  option. After you turn on the footer for a particular grid, that

setting will be remembered until the user opts to hide the footer. To hide the footer, right-click on a column

header and select Hide footerHide footer . (The placement of the Show footer/Hide footerShow footer/Hide footer  action might move to a new

location in a future update.

Currently, no columns show totals by default. Instead, this is considered a one-time setup activity, similar to

adjusting the widths of columns in grids. Once you specify that you want to see totals for a column, that setting

will be remembered the next time you visit the page.

There are two ways to configure a column to show a total:

Right-click in the column that you want to see a total for, and then select Total this columnTotal this column. This action

causes three events to occur :

1. The footer becomes visible.

2. Your preference for seeing a total for this column is saved.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/grid-capabilities.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/public-preview-releases


Calculating totalsCalculating totals

Typing ahead of the system

3. A calculation of totals is initiated for this column and any other columns that you previously

configured to see totals for. The time that is required to show a total depends on the size of the dataset

that you're totaling.

After the footer is visible, select Show totalShow total  in the footer area at the bottom of the column that you want

to see a total for. If there are no configured columns, the Show totalShow total  button will be available for all

numeric columns.

After at least one column is configured for totals, the Show totalShow total  buttons will be available only on hover

or focus. The action of selecting Show totalShow total  just saves your preference for seeing a total in this column,

so that the preference is applied during future visits to the page. In the footer, this state is indicated by a

dash that appears in the column. (Alternatively, if the dataset is small enough, a total is immediately

shown.)

If you make a mistake and no longer want to see a total in a particular column, right-click on the column and

select Hide totalHide total  or select the Hide totalHide total  button in the footer in that column. This preference will also be saved

for future visits to the page.

When you come to a page with the footer visible and columns already configured for totals, totals may or may

not be shown in the footer. The behavior is dependent on the size of the dataset on the page. If the dataset is

sufficiently small, totals will be shown automatically, along with the number of rows in the dataset. If there are

dashes in the footer under the columns you configured for totals, then the dataset is too large for the system to

show totals immediately, and an explicit action is needed to calculate the totals. To do this, click the CalculateCalculate

button in the footer, or right-click on a column you want a total for and select Total this columnTotal this column.

If the calculation is taking too long, you can cancel the operation by selecting the CancelCancel  button. Sometimes,

however, the dataset will be too large to calculate totals (a limit imposed by your organization), and you will

instead be notified to filter your data more.

Totals will update automatically as you update, delete, or create rows in the dataset.

In many business scenarios, the ability to quickly enter data into the system is very important. Before the new

grid control was introduced, users could change data only in the current row. Before they could create a new

row or switch to a different row, they were forced to wait for the system to successfully validate any changes. In

an attempt to reduce the amount of time that users wait for these validations to be completed, and to improve

user productivity, the new grid adjusts these validations so that they are asynchronous. Therefore, the user can

move to other rows to make changes while previous row validations are pending.

To support this new behavior, a new column for the row status has been added to the right of the row selection

column when the grid is in edit mode. This column indicates one of the following statuses:

BlankBlank – No status image indicates that the row has been successfully saved by the system.

Processing pendingProcessing pending – This status indicates that the changes in the row haven't yet been saved by the

server but are in a queue of changes that must be processed. Before you take action outside the grid, you

must wait for all the pending changes to be processed. Additionally, the text in these rows is italicized to

indicate the unsaved status of the rows.

Invalid stateInvalid state – This status indicates that some warning or message was triggered during the processing of

the row, and it might have prevented the system from saving the changes in that row. In the old grid, if the

save operation was unsuccessful, you were forced back into the row to fix the issue immediately. However, in

the new grid, you're notified that a validation issue was encountered, but you can decide when you want to

fix any issues in the row. When you're ready to fix an issue, you can manually move focus back to the row.

Alternatively, you can select the Fix this issueFix this issue action. This action immediately moves focus back to the row

that has the issue, and lets you make edits inside or outside the grid. Note that the processing of subsequent



Pasting from ExcelPasting from Excel

Evaluating math expressions

Grouping tabular data

pending rows is stopped until this validation warning is resolved.

PausedPaused – This status indicates that processing by the server is paused because validation of the row

triggered a pop-up dialog box that requires user input. Because the user might be entering data in some

other row, the pop-up dialog box isn't immediately presented to that user. Instead, it will be presented when

the user chooses to resume processing. This status is accompanied by a notification that informs the user

about the situation. The notification includes a Resume processingResume processing action that will trigger the pop-up

dialog box.

When users are entering data ahead of the place where the server is processing, they can expect a few

degradations in the data entry experience, such as a lack of lookups, control-level validation, and entry of default

values. Users who need a drop-down list to find a value are encouraged to wait for the server to catch up to the

current row. Control-level validation and entry of default values will also occur when the server processes that

row.

Users have always been able to export data from grids in Finance and Operations apps to Excel by using the

Expor t to ExcelExpor t to Excel  mechanism. However, the ability to enter data ahead of the system enables the new grid to

support copying tables from Excel and pasting them directly into grids in Finance and Operations apps. The grid

cell that the paste operation is initiated from determines where the copied table begins to be pasted in. The

contents of the grid are overwritten by the contents of the copied table, except in two cases:

If the number of columns in the copied table exceeds the number of columns that remain in the grid, starting

from the paste location, the user is notified that the extra columns have been ignored.

If the number of rows in the copied table exceeds the number of rows in the grid, starting from the paste

location, the existing cells are overwritten by the pasted content, and any extra rows from the copied table

are inserted as new rows at the bottom of the grid.

As a productivity booster, users can enter mathematical formulas in numeric cells in a grid. They don't have to

do the calculation in an app outside the system. For example, if you enter =15*4=15*4  and then press the TabTab key to

move out of the field, the system will evaluate the expression and save a value of 6060  for the field.

To make the system recognize a value as an expression, start the value with an equal sign (==). For more

information about the supported operators and syntax, see Supported math symbols.

Business users often need to perform ad-hoc analysis of data. While this can be done by exporting data to

Microsoft Excel and using pivot tables, the Grouping in gr idsGrouping in gr ids  feature, which is generally available in version

10.0.16/Platform update 40 and is dependent on the new grid control feature, allows users to organize their

tabular data in interesting ways within Finance and Operations apps. Because this feature extends the TotalsTotals

feature, GroupingGrouping allows you to get meaningful insights into the data by providing subtotals at the group level.

To use this feature, right-click the column that you want to group by, and select Group by this columnGroup by this column. This

action will sort the data by the selected column, add a new Group byGroup by  column to the beginning of the grid, and

insert "header rows" at the beginning of each group. These header rows provide the following information

about each group:

Data value for the group

Column name (this information is especially useful when you have multiple levels of grouping)

Number of data rows in this group

Subtotals for any column configured to show totals

http://bugwheels94.github.io/math-expression-evaluator/#supported-maths-symbols


Multiple levels of groupingMultiple levels of grouping

Expanding and collapsing groupsExpanding and collapsing groups

Selecting and unselecting rows at the group levelSelecting and unselecting rows at the group level

Hiding column namesHiding column names

Freezing columns

Frequently asked questions

With Saved views enabled, this grouping can be saved by personalization as part of a view for quick access the

next time you visit the page.

After you've grouped data by a single column, you can group the data by a different column by selecting GroupGroup

by this columnby this column on the desired column. This process can be repeated until you have 5 nested levels of

grouping, which is the maximum supported depth. At this point, you will no longer be able to group by

additional columns.

At any point, you can remove the grouping on any column by right-clicking that column and selecting

UngroupUngroup. You can also remove the grouping from all columns by selecting Grid optionsGrid options  and then UngroupUngroup

allall .

Note, prior to version 10.0.16/Platform update 40, only one level of grouping is supported. In these versions, if

the data is grouped and you select Group by this columnGroup by this column for a different column, the original grouping is

replaced.

The initial grouping of data will have all groups expanded. You can create summarized views of the data by

collapsing individual groups, or you can use group expanding and collapsing to assist in navigating through the

data. To expand or collapse a group, select the chevron (>) button in the corresponding group header row. Note

that the expand/collapse state of individual groups is notnot saved in personalization.

In the same way that you can select (or unselect) all rows in the grid by selecting the check box at the top of the

first column in the grid, you can also quickly select (or unselect) all the rows in a group by selecting the check

box in the corresponding group header row. The check box in the group header row will always reflect the

current selection state of rows in that group, regardless of whether all rows are selected, no rows are selected, or

only some rows are selected.

When grouping data, the default behavior is to show the column name in the group header row. Starting in

version 10.0.14/Platform update 38, you can choose to suppress the column name in group header rows by

selecting Grid optionsGrid options  > Hide group column nameHide group column name.

Some columns in a grid might be important enough for context that you don't want them to scroll out of view.

Instead, you want the values in those columns always to be visible. In version 10.0.17, the Freeze columns inFreeze columns in

gridgrid feature provides this flexibility to users.

To freeze a column, right-click in the column's header, and then select Freeze columnFreeze column. The first time that you

complete this step, the selected column becomes the first column and will no longer scroll out of view. Any

subsequent column that you freeze will be added to the right of the last frozen column. You can use the standard

Move functionality to reorder frozen columns as you require. However, frozen columns can't be moved so that

they appear among the set of unfrozen columns. Likewise, unfrozen columns can't be moved so that they

appear among the set of frozen columns.

To unfreeze a column, right-click in the frozen column's header, and then select Unfreeze columnUnfreeze column.

Note that the row selection and row status columns in the new grid are always frozen as the first two columns.

Therefore, when these columns are included in a grid, they will always be visible to users, regardless of the

horizontal scroll position in the grid. These two columns can't be reordered.



How do I enable the new grid control in my environment?How do I enable the new grid control in my environment?

[Developer] Opting out individual pages from using the new grid

[Developer] Size-to-available-width columns

Known issues

Open issuesOpen issues

10.0.9 / Platform update 33 and later10.0.9 / Platform update 33 and later

The New grid controlNew grid control  feature is available directly in Feature management in any environment. Like other

public preview features, enabling this feature in production is subject to the Supplemental Terms of Use

Agreement.

10.0.8 / Platform update 32 and 10.0.7 / Platform update 3110.0.8 / Platform update 32 and 10.0.7 / Platform update 31

The New grid controlNew grid control  feature can be enabled in Tier 1 (Dev/Test) and Tier 2 (Sandbox) environments in order

to provide additional testing and design changes by following the steps below.

1. Enable the flightEnable the flight: Execute the following SQL statement:

INSERT INTO SYSFLIGHTING (FLIGHTNAME, enabled, FLIGHTSERVICEID, PARTITION)
VALUES('CLIReactGridEnableFeature', 1, 0, 5637144576);

2. Reset IISReset IIS  to flush the static flighting cache.

3. Find the featureFind the feature: Go to the Feature managementFeature management workspace. If New grid controlNew grid control  does not appear

in the list of all features, select Check for updatesCheck for updates .

4. Enable the featureEnable the feature: Find the New grid controlNew grid control  feature in the list of features, and select Enable nowEnable now

on the details pane. Note that a browser refresh is required.

All subsequent user sessions will start with the new grid control enabled.

If your organization discovers a page that has some issues utilizing the new grid, an API is available starting in

version 10.0.13/Platform update 37 to allow an individual form to use the legacy grid control while still

permitting the rest of the system to utilize the new grid control. To opt out an individual page from the new grid,

add the following call post super()  in the run()  method for the form.

this.forceLegacyGrid();

This API will be honored until the October 2021 release, when the new grid control becomes mandatory. If any

issues require that this API be used, report them to Microsoft.

If a developer sets the WidthModeWidthMode property to S izeToAvailableSizeToAvailable for columns inside the new grid, those

columns initially have the same width that they would have if the property were set to S izeToContentSizeToContent.

However, they stretch to use any extra available width inside the grid. If the property is set to S izeToAvailableSizeToAvailable

for multiple columns, all those columns share any extra available width inside the grid. However, if a user

manually resizes one of those columns, the column becomes static. It will remain at that width and will no

longer stretch to take up extra available grid width.

This section maintains a list of known issues for the new grid control.

After enabling the New grid controlNew grid control  feature, some pages will continue to utilize the existing grid

control. This will happen in the following situations:

A card list exists on the page that is rendered in multiple columns.

A grouped card list exists on the page.

https://go.microsoft.com/fwlink/?linkid=2105274


Fixed as part of 10.0.16Fixed as part of 10.0.16

Fixed as part of 10.0.15Fixed as part of 10.0.15

Fixed as part of 10.0.14Fixed as part of 10.0.14

Fixed as part of 10.0.13Fixed as part of 10.0.13

A grid column with a non-react extensible control.

When a user first encounters one of these situations, a message will display about refreshing the page.

After this message appears, the page will continue to utilize the existing grid for all users until the next

product version update. Better handling of these scenarios, so that the new grid can be utilized, will be

considered for a future update.

[KB 4582758] Records are blurry when you change zoom from 100 to any other percentage

[KB 4592012] Unexpected client error in IE11 when pasting multiple lines from Excel

Microsoft is not pursuing a fix for this issue

[KB 4598335] Multi-line string controls do not respect their DisplayHeights in lists/cards

[KB 4591891] Invoice proposal lines disappear when unmarking lines

[KB 4592104] Unable to edit records after clicking "Fix issue" and moving to a different row without fixing the

validation issue

[KB 4594449] "Never" and "Clear" buttons missing inside the date picker

[KB 4594448] Entering time is treated differently with the new grid

[KB 4600059] Unexpected client error with email throttling

[KB 4574584] Expense attachment preview not available when hovering over the receipt icon

(Quality update) [KB 4594444] Unexpected client error with preview for segmented entry control

[KB 4582723] Display options not showing when done later in the form life cycle

[KB 4591988] Issues using the keyboard to select a value from a ReferenceGroup lookup

[KB 4588958] Regression Suite Automation Tool (RSAT) test fails with error : TypeError : Cannot read property

'text' of undefined

[KB 4591970] Unexpected client error when pasting from Excel was done immediately after clicking into the

grid

[KB 4591904] Data changes are not saved if after editing a control the user immediately clicked and opened

the lookup of a different control

[KB 4584752] Unexpected client error with Project invoice proposals page

[KB 4584540] Unable to leave the grid after pasting a single row into a journal line

[KB 4591908] When creating a new row, focusing is staying in the column you were in

(Quality update) [KB 4584752] Unexpected client error with Project invoice proposals page

[KB 4583880] Regression Suite Automation Tool (RSAT) tests fail on OpenLookup action with "Cannot read

property RowIndex of undefined"

[KB 4583847] Unexpected client error when navigating through lookups

(Quality update) [KB 4584752] Unexpected client error with Project invoice proposals page

(Quality update) [KB 4583880] Regression Suite Automation Tool (RSAT) tests fail on OpenLookup action

with "Cannot read property RowIndex of undefined"

(Quality update) [KB 4583847] Unexpected client error when navigating through lookups

(Quality update) [Bug 471777] Cannot select fields in a grid to edit or create a mobile app

[KB 4582727] Grid freezes after user gets dialog for items with multiple quantities

[Bug 474851] Hyperlinks in reference group controls don't work

[Bug 474848] Enhanced previews with grids do not display



Fixed as part of 10.0.12Fixed as part of 10.0.12

[KB 4582726] The RotateSign property isn't being respected

[Bug 470173] Check boxes in inactive rows toggle when the whitespace in the cell is clicked

[Bug 474848] Enhanced previews with grids do not display

[Bug 474851] Hyperlinks in reference group controls don't work

[Bug 471777] Cannot select fields in a grid to edit or create a mobile app

[KB 4569441] Issues with rendering multi-column card lists, tooltips on images, and display options on some

fields

[KB 4575279] Not all marked rows are deleted in General Journal

[KB 4575233] Display options are not restored after moving to another row

[Bug 477884] Lookups return wrong value/record if new grid control is activated

[KB 4571095] Product receipt posting occurs when accidentally pressing Enter (correct handling of a page's

default action)

[KB 4575437] Lookups with editable controls close unexpectedly

[KB 4569418] Duplicate line created in delivery schedule form

[KB 4575435] Enhanced preview sometimes persists even when the mouse pointer isn't near the field

[KB 4575434] Lookup isn't filtering when the field has been modified

[KB 4575430] Values in password fields aren't masked in the grid

[KB 4569438] "Processing has stopped because of a validation issue" displays after marking lines while

settling supplier transactions

[KB 4569434] Refreshing the Legal entities form results in fewer records

[KB 4575297] Focus keeps moving to the task recorder pane when editing and tabbing through a grid

[KB 4566773] Correction transactions not showing as negative on voucher transactions inquiry

[KB 4575288] Focus resets to the active row when selecting the border between rows in a simple list

[KB 4575287] Focus doesn't return to the first column when using the down arrow to create a new row in

journals

[KB 4564819] Cannot delete lines in a free text invoice (because the datasource

ChangeGroupMode=ImplicitInnerOuter)

[KB 4563317] Tooltips/enhanced previews aren't shown for images

[KB 4558545] Table controls don't update the contents of displayed items.

[KB 4558570] Items are still shown on the page after the record has been deleted.

[KB 4558572] Styling that is associated with the List Panel ExtendedStyleExtendedStyle isn't applied.

[KB 4558573] Validation errors can't be fixed when the required change is outside the grid.

[KB 4558584] Negative numbers aren't rendered correctly.

[KB 4560726] An "unexpected client error" occurs after swapping between lists is done by using a List View

control.

[KB 4562141] Grid indices are off after a new record is added.

[KB 4562151] The ValidateValidate and CopyCopy  task recorder options aren't available for date/number controls.

[KB 4562153] Multi-select check boxes aren't visible on list/card grids.

[KB 4562646] You sometimes can't click outside the grid after you multi-select rows in the grid.

[KB 4562647] Focus is reset to the first control in the PublishPublish dialog box after a new row is added in the

security roles grid.

[KB 4563310] The enhanced preview isn't closed after a row is changed.

[KB 4563313] An "unexpected client error" occurs in Internet Explorer when a value is selected in a lookup.

[KB 4564557] Lookups and drop-down menus won't open in Internet Explorer

[KB 4563324] Navigation doesn't work after the Personnel managementPersonnel management workspace is opened.



Fixed as part of 10.0.11Fixed as part of 10.0.11

Fixed as part of 10.0.10Fixed as part of 10.0.10

Quality update for 10.0.9/Platform update 33Quality update for 10.0.9/Platform update 33

NOTENOTE

[Issue 432458] Empty or duplicated lines are shown at the beginning of some child collections.

[KB 4549711] Lines in a payment proposal can't be removed correctly after the new grid control is enabled.

[KB 4558374] Records that require a polymorphic selector dialog box can't be created.

[KB 4558375] Help text isn't shown on columns in the new grid.

[KB 4558376] List Panel grids aren't rendered at the correct height in Internet Explorer.

[KB 4558377] Combo box columns that have S izeToAvailableSizeToAvailable width aren't rendered on some pages.

[KB 4558378] Drill-through sometimes opens the wrong record.

[KB 4558379] An error occurs when lookups are opened where ReplaceOnLookupReplaceOnLookup=NoNo.

[KB 4558380] The available space in the grid isn't filled immediately after part of the page is collapsed.

[KB 4558381] Negative numbers aren't rendered correctly / Users sometimes become stuck after validation

issues are encountered.

[KB 4558382] Unexpected client errors occur.

[KB 4558383] Controls outside the grid aren't updated after the last record is deleted.

[KB 4558587] Reference groups that have combo boxes for replacement fields don't show values.

[KB 4562143] Fields aren't updated after a row change / Grid processing becomes stuck after row deletion.

[KB 4562645] An exception occurs when a lookup is opened while Regression Suite Automation Tool (RSAT)

tests are running.

[Issue 414301] Some data from previous lines disappears when new lines are created.

[Bug 417044] There is no empty grid message for list-style grids.

[KB 4539058] Some grids (typically on FastTabs) sometimes aren't rendered (but they will be rendered if you

zoom out).

[KB 4549734] Active rows aren't treated as marked if the marking column is hidden.

[KB 4549796] Values can't be edited in a grid when it's in view mode.

[KB 4558367] Text selection is inconsistent when rows are changed.

[KB 4558368] Multi-select via the keyboard is allowed in single-select scenarios.

[KB 4558369] Status images disappear in the hierarchical grid.

[KB 4558370] A new row isn't scrolled into view.

[KB 4558372] The new grid becomes stuck in processing mode if the number of columns in content that is

pasted in exceeds the number of remaining columns in the grid.

[KB 4562631] Time values aren't formatted correctly.

[KB 4550367] Time values aren't formatted correctly.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Creating custom fields

While there is an extensive set of fields out-of-the-box for managing a broad range of business processes,

sometimes there is a need for a company to track additional information in the system. While programmers can

be used to add those fields as extensions in the developer tools, the custom fields feature allows fields to be

added directly from the user interface, thereby allowing you to tailor the application to fit your business using

your web browser.

The ability to add custom fields is available in platform update 13 and later. Only users with special permissions

have access to this feature.

This video shows how easy it is to add a custom field to a page: Adding custom fields.

After you've identified additional information that you would like to track in the application, you can create the

custom field on the appropriate table and expose that new field on a page.

The following steps describe the process for creating a custom field and placing that field on a form.

1. Navigate to the form where the new field is needed.

2. Because the end goal is to expose the custom field on a form, the entry point for creating custom fields

exists inside the personalization experience. Open the personalization toolbar by selecting OptionsOptions , and

then Personalize this formPersonalize this form .

3. Click Inser tInser t and then FieldField.

4. Select the region of the form where you want to expose the new field. After selection, the Inser t fieldsInser t fields

dialog box will display a list of existing fields that can be inserted into the selected region of the form.

5. Ensure that the field you are interested in does not already exist in the list. If it does, you can simply select

that field in the list and click Inser tInser t.

6. Click the Create new fieldCreate new field button above the list to initiate the process of creating a custom field. This

will open the Create new fieldCreate new field dialog box.

If you do not see the Create new fieldCreate new field button, you do not have the necessary permissions to use this

feature.

7. In the Create new fieldCreate new field dialog box, enter the following information.

a. Select the database table where this field should be added. Note that only tables that support

custom fields will appear in the drop-down list. See the section below for technical details on

supported tables.

b. Select the data type for the new field. The available data types are checkbox, date, date time,

decimal, number, picklist, and text.

If you choose the text data type, you can also specify the maximum length of the text that can

be entered in this field.

If you choose the picklist data type, you can also select the set of valid values for the field.

c. Provide a name, label, and help text for the field. The name corresponds to the physical field name

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/user-defined-fields.md
https://www.youtube.com/watch?v=gWSGZI9Vtnc


Sharing custom fields with other users

Managing custom fields

Viewing all custom fieldsViewing all custom fields

Editing custom fieldsEditing custom fields

in the database, whereas the label and help text are the text used to represent this field in the user

interface.

8. If this is the only field that you need to create for this form, click SaveSave. If you need to create additional

fields, click Save and newSave and new  and go back to step 7. Note that there is currently a limit of 20 custom20 custom

fields per tablefields per table.

9. Leaving the Create new fieldCreate new field dialog box will return you to the Inser t fieldsInser t fields  dialog box. Any custom

fields that were just added will be automatically marked in the field list to be inserted into the form.

10. Click Inser tInser t to insert the marked fields into the selected region of the form.

11. Optional:Optional: Enable MoveMove mode from the personalization toolbar to move the new fields to their desired

location in the selected region. See Personalize the user experience for more information about how to

use the various personalization capabilities to optimize a form for your personal usage.

After you have created a custom field and exposed it on a form, you might want to provide this updated page

view that includes the new field to other users in the system. This can be accomplished in two different ways

using the personalization capabilities of the product:

The recommended route is through the system administrator, who can push a personalization to all users or

a subset of users. See Personalize the user experience for more details.

Alternatively, you can export your changes (called personalizations), send them to one or more users, and

have each of those users import your changes. The ManageManage option on the personalization toolbar enables

you to export and import personalizations.

Management of all the custom fields in the system can be accomplished through the Custom fieldsCustom fields  page in the

System administration module. This page allows users access to many capabilities, including:

Viewing a list of all custom fields in the system.

Limited editing of existing custom fields.

Deleting custom fields.

Exposing custom fields on data entities.

Providing translations of custom field labels and help text.

The Custom fieldsCustom fields  page provides visibility to all the custom fields that have been defined in the system. Simply

select the table that you are interested in, and the page will update to show a list of the custom fields associated

with that table. Choosing a custom field from the list will allow you to view all the details about the field.

After a custom field has been created, only certain pieces of information about the custom field can be modified

on the Custom fieldsCustom fields  page.

You can modify these attributes:

Label

Help text

Length, for Text fields

You cannot edit the following attributes:



Exposing custom fields on data entitiesExposing custom fields on data entities

Allowing custom fields to be displayed in other languagesAllowing custom fields to be displayed in other languages

Deleting custom fieldsDeleting custom fields

NOTENOTE

Appendix
Who can create custom fields?Who can create custom fields?

Field name

Data type

Additionally, for picklist fields, the set of valid values for the custom field can be reordered, and new values can

be added; however, existing values for the picklist field cannot be removed. Remember to click Apply changesApply changes

when you are done editing fields for a particular table so the changes are saved.

It may also be important to allow custom fields to be visible on data entities. Data entities are utilized in the

Office integration overview feature, as well as for data import/export scenarios.

Follow these steps to expose a custom field on a data entity:

1. Select the custom field on the Custom fieldsCustom fields  form.

2. Expand the EntitiesEntities  section to view the set of relevant entities.

3. Click the EditEdit button.

4. Modify the EnabledEnabled field to be selected for each entity that should expose this field.

5. Click Apply changesApply changes  to save your selections.

Because custom fields may need to be accessed by users in a variety of languages, the Custom fieldsCustom fields  page

provides a mechanism to allow the label and help text for a custom field to be translated into other languages.

The following steps describe the process for translating custom fields in other languages:

1. Select the custom field on the Custom fieldsCustom fields  page.

2. Select the TranslationsTranslations  button in the Action Pane. This will open a drop-down menu with existing

translations for this field.

3. The LanguageLanguage drop-down menu shows the set of languages for which translations have already been

provided.

If you want to edit an existing translation, select the desired language from the menu and modify the

values for the label and help text.

Otherwise, click the Add languageAdd language button, select the desired language from the menu, and then provide

translated values for the label and help text.

4. Click OKOK when you are finished.

In some rare cases, you may decide that a custom field is no longer needed. When this occurs, a system

administrator can choose to delete the field from the Custom fieldsCustom fields  page. To do this, ensure the correct field is

selected, click DeleteDelete, click YesYes  to confirm the deletion, and finally click Apply changesApply changes .

This action cannot be undone, and will result in the data associated with the field being permanently deleted from the

database.

As a safeguard to the system, only system administrators are able to create custom fields by default. However,

those power users whom the organization deems necessary can be given rights to create custom fields by a



What tables support custom fields?What tables support custom fields?

Can I reference custom fields from the developer tools?Can I reference custom fields from the developer tools?

NOTENOTE

system administrator using the Runtime customization power userRuntime customization power user  security role. Users without this security

role will not be able to create custom fields, but will still be able to see and interact with custom fields added by

other users in the system.

For performance and technical reasons, only tables that meet the following conditions currently allow custom

fields to be added.

The table must be tagged as one of these groups:

Group

WorksheetHeader

Main

Miscellaneous

Parameter

Reference

TransactionHeader

The table cannot extend another table.

The table cannot be marked as a system table.

The table cannot be a temporary table.

Custom fields can only be managed through the user interface and cannot be referenced by code.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Adding an embedded canvas app from Power Apps to a page
OverviewOverview

NOTENOTE

DetailsDetails

Microsoft Power Apps is a service that lets developers and non-technical users build custom business apps for

mobile devices, tablets, and the web without writing code. Finance and Operations apps support integration

with Power Apps. Canvas apps that you, your organization, or the broader ecosystem develop can be embedded

into Finance and Operations apps to augment the product's functionality. For example, you might build a canvas

app from Power Apps to supplement a Finance and Operations app with information that is retrieved from

another system.

To learn more about embedding Power Apps, watch the short How to embed Power Apps video.

Before you embed a canvas app from Power Apps into the client, you must find or build an app that has the

desired visuals or functionality. This topic doesn't include a detailed description of the process for building apps.

If you're new to Power Apps, see the Power Apps documentation.

There are two ways to access a specific canvas app on a page when you're ready to embed the app. You can

choose whichever approach fits your scenario better. The first approach uses the Power AppsPower Apps  button that has

been added to the standard Action Pane. Apps that you add by using this approach appear as items on the

Power AppsPower Apps  menu button. When you select one of these items, a side pane that contains the embedded app

appears. Alternatively, you can embed an app directly on a page as a new tab, FastTab, or blade, or as a new

section in a workspace.

When you configure your embedded canvas app, you can select a single field that you want to send as context

to the app. This step enables the app to be responsive, based on the data that you're currently viewing.

You can't currently use this mechanism to embed modeled apps.

The following procedure shows how to embed a canvas app from Power Apps into the web client.

1. Go to the page where you want to embed the canvas app. This page will be the page that contains data

that must be passed to the app as input.

2. Open the Add an app from Power AppsAdd an app from Power Apps  pane:

Click OptionsOptions , and then select Personalize this pagePersonalize this page. Under the Inser tInser t menu, choose Power AppsPower Apps .

Finally, select the region where you would like to add the app. If you want to embed the app under the

Power Apps menu button, choose the Action Pane. If you want to embed the app directly onto the

page, choose the appropriate tab, FastTab, blade, or section (if you're on a workspace).

If the app will be accessed using the Power Apps menu button, you can alternatively click the PowerPower

AppsApps  menu button in the standard Action Pane, and then select Add an appAdd an app.

3. Configure the embedded app:

The NameName field indicates the text shown for the button or tab that will contain the embedded app.

Oftentimes, you may want to repeat the name of the app in this field.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/embed-power-apps.md
https://www.youtube.com/watch?v=x3qyA1bH-NY
https://docs.microsoft.com/en-us/powerapps/


 

Sharing an embedded app
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Building a canvas app that uses data that is sent from Finance and
Operations apps

The App IDApp ID field indicates the globally unique identifier (GUID) for the canvas app that you want to

embed. To retrieve this value, find the app on make.powerapps.com, and then look in the App IDApp ID field

under DetailsDetails .

For Input context for the appInput context for the app, you can optionally select the field that contains the data that you

want to pass to the app as input. See the section later in this topic titled Building an app that leverages

data sent from Finance and Operations apps for details on how the app can access the data sent from

Finance and Operations apps.

Choose the Application sizeApplication size that matches the type of app that you're embedding. Select ThinThin for

apps built for mobile devices, and WideWide for apps built for tablets. This ensures a sufficient amount of

space is allotted for the embedded app.

The Legal entitiesLegal entities  FastTab provides the ability to choose which legal entities the app is available for.

The default is to make the app accessible to all legal entities. This option is only available when the

Saved views feature is disabled.

4. After confirming that the configuration is correct, click Inser tInser t to embed the Power App on the page. You

will be prompted to refresh the browser in order to see the embedded app.

After you've embedded a canvas app on a page and confirmed that it's working correctly with any data context

that is passed from that page, you might want to share the app with other users in the system. To share an

embedded canvas app, follow these steps.

1. Share the canvas app with the appropriate users, so that they can access the app in Power Apps.

2. Make sure that the targeted users have the appropriate personalizations, so that the embedded app

appears when those users view the page. You can use either of the following approaches:

Recommended: Use the Saved views feature to create and publish a view that includes the embedded

app. This approach ensures that all users who have the security roles that are targeted by the

published view will see the app in Finance and Operations apps.

If you don't have the Saved views feature turned on, you can have the system admin push a

personalization that includes the embedded app to all users or a subset of users. Alternatively, you can

export your page's personalizations, and send them to one or more users. Each of those users can

then import the personalizations. The personalization toolbar has actions that let you export and

import personalizations.

If the canvas app has been shared with external users, those users can't use the embedded app inside Finance and

Operations apps. However, they can access the app directly inside Power Apps. External users include guests and users

who don't belong to the Microsoft 365 Azure Directory where the Finance and Operations app is deployed.

See Personalize the user experience for more details about the personalization capabilities in the product and

how to use them.

When you build a canvas app that will be embedded in a Finance and Operations app, one important part of the

process is to use the input data from that Finance and Operations app. From the Power Apps development

experience, the input data that is passed from a Finance and Operations app can be accessed by using the

Param("EntityId")Param("EntityId")  variable.

https://make.powerapps.com
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/share-app


 

If(!IsBlank(Param("EntityId")), Set(FinOpsInput, Param("EntityId")), Set(FinOpsInput, ""));

Viewing a canvas app

Editing an embedded app

Removing an app

Appendix
[Developer] Specifying where an app can be embedded[Developer] Specifying where an app can be embedded

For example, in the OnStart function of the app, you could set the input data from Finance and Operations apps

to a variable like this:

To view an embedded canvas app on a page in Finance and Operations apps, just go to a page that has an

embedded app. Remember that apps can be accessed by using the Power AppsPower Apps  button on the standard Action

Pane. Alternatively, they can appear directly on the page as a new tab, or FastTab, or blade, or as a new section in

a workspace. When users first try to load an app on a page, they will be prompted to sign in. This step ensures

that the users have the appropriate permissions to use the app.

After an app has been embedded onto a page, you may need to make some changes to the configuration of the

app. For example, perhaps you want to modify the label associated with the embedded app or a new version of

the app has been created and you need to update the App ID to point at the latest.

Follow these steps to edit the configuration of an embedded app:

1. Go to the Edit the appEdit the app pane.

If the embedded app is accessed through the Power Apps menu button, right-click on the Power Apps

menu button and select PersonalizePersonalize. Select the app that you want to configure from the Select anSelect an

appapp drop-down menu.

If the embedded app appears directly on the page, select OptionsOptions , and then select Personalize thisPersonalize this

pagepage. Using the SelectSelect tool, click the embedded app.

2. Make the needed modifications to the app configuration, and then click SaveSave.

After an app has been embedded onto a page, there are two ways to remove it if needed:

Go to the Edit an appEdit an app pane using the instructions from the Editing an embedded app section earlier in this

topic. Confirm that the pane displays information for the embedded app that you would like to remove, and

then click the DeleteDelete button.

Because the embedded app is saved as personalization data, clearing your page's personalization will also

remove any embedded apps on that page. Note that clearing the page's personalization is permanent and

cannot be undone. To remove your personalizations on a page, select OptionsOptions , and then Personalize thisPersonalize this

pagepage, and finally the ClearClear  button. After refreshing your browser, all the previous personalizations for this

page will be removed. See Personalize the user experience for more information about how to optimize

pages using personalization.

By default, users can embed apps on any page, either under the Power Apps menu button or directly on the

page as a tab, FastTab, blade or as a new section in a workspace. However, if required, developers can also

configure this feature to only allow embedding of apps on certain pages by implementing the following

methods:

isPowerAppPersonalizationEnabledisPowerAppPersonalizationEnabled – If this method returns false for a specific page, then the Power



[ExtensionOf(classStr(FormRunConfigurationPowerAppsConfiguration))]

public final class ClassTest_Extension
{
    public static boolean isPowerAppPersonalizationEnabled(str pageName)
    {
        var result = next isPowerAppPersonalizationEnabled(pageName);
        return result;
    }
    
    public static boolean isPowerAppTabPersonalizationEnabled(str pageName)
    {
        var result = next isPowerAppTabPersonalizationEnabled(pageName);
        return result;
    }
}

NOTENOTE

Apps menu button will not be shown, and users will not be able to embed apps anywhere on this page,

including as a tab.

isPowerAppTabPersonalizationEnabledisPowerAppTabPersonalizationEnabled – If this method returns false for a specific page, then users will

not be able to embed apps directly on the page as a tab, FastTab, or panorama section. Users will still be able

to embed apps through the Power Apps menu button if embedding is allowed on the page.

The following example shows a new class with the two methods needed to configure where apps can be

embedded.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Responsive lookups

Many fields have lookups that can help you easily find the correct or desired value. Several enhancements have

been added to lookups that make these controls more usable and make users more productive. In this topic, you

will learn about these new lookup features and will receive some helpful tips to get the optimal use out of

lookups in the system.

In previous versions, when interacting with a lookup control, a user would have to take an explicit action to open

the drop-down menu. This may have been by typing an asterisk (*) in the control to filter the lookup based on

the current value of the control, clicking the drop-down button, or by using the AltAlt+Down arrowDown arrow  keyboard

shortcut. Lookup controls have been modified in the following ways to better align with current web practices:

Lookup drop-down menus will now open automatically after a slight pause in typing, with the drop-down

menu contents filtered based on the lookup control's value.

Note that the old behavior of automatic opening of the dropdown after typing an asterisk (*) has been

deprecated.

After the lookup drop-down menu has opened, the following will occur :

The cursor will stay in the lookup control (instead of focus moving into the drop-down menu) so you

can continue to make modifications to the control's value. However, the user can still use the UpUp

arrowarrow  and Down arrowDown arrow  to change rows in the drop-down menu, and enter to select the current row

in the drop-down menu.

The contents of the drop-down menu will adjust after any modifications are made to the lookup

control's value.

For example, consider a lookup field called CityCity .

When focus is in the CityCity  field, you can start looking for the city that you want by typing a few letters, like "col."

After you stop typing, the lookup will open automatically, filtered to those cities that begin with "col".

At this point, the cursor is still in the lookup field. If you continue typing so the value is "colum," the lookup

contents adjust automatically to reflect the latest value in the control.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/use-lookups-to-find-information.md
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/media/typeaheadlookupexample.png


Typing in more than IDs

Even though focus is still in the lookup control, you can also use the Up arrowUp arrow  or Down arrowDown arrow  keys to

highlight the row that you want to select. If you press EnterEnter  the highlighted row will be selected from the

lookup and the control's value will be updated.

When entering data, it's natural for users to attempt to identify an entity, such as a customer or vendor, in terms

of the name rather than an identifier representing the entity. Many (but not all) lookups now allow contextual

data entry. This powerful feature allows the user to type the ID or the corresponding name into the lookup

control.

For example, consider the Customer accountCustomer account field when creating a sales order. This field shows the AccountAccount

IDID for the customer, but a user would typically prefer to enter an Account nameAccount name instead of an Account IDAccount ID for

this field when creating a sales order, such as "Forest Wholesales" instead of "US-003."

If the user started to enter an Account IDAccount ID into the lookup control, the drop-down menu would automatically

open as described in the previous section and the user would see the lookup as shown below.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/media/howtocontextuallookups-1.png


Using grid column headers for more advanced filtering and sorting

However, the user can also now enter the beginning of an Account nameAccount name as well. If this is detected, then the

user will see the following lookup. Notice how the NameName column is moved to be the first column in the lookup,

and how the lookup is sorted and filtered based on the NameName column.

The lookup enhancements discussed in the previous two sections greatly improve a user's ability to navigate the

rows in a lookup based on a "begins with" search of the IDID or NameName field in the lookup. However, there are

situations in which more advanced filtering (or sorting) is needed to find the correct row. In these situations, the

user needs to use the filtering and sorting options in the grid column headers inside the lookup. For example,

consider an employee entering a sales order line who needs to locate the right "cable" as the product. Typing

"cable" into the Item numberItem number  control isn't helpful, as there are no product names that begin with "cable."

Instead, the user needs to clear the value of the lookup control, open the lookup drop-down menu, and filter the

drop-down menu using the grid column header, as shown below. A mouse (or touch) user can simply click (or

touch) any column header to access the filtering and sorting options for that column. For a keyboard user, the

user simply needs to press AltAlt+DownDown arrowarrow  a second time to move focus into the drop-down menu, after

which the user can tab to the correct column, and then press Ctr lCtr l+GG to open the grid column header drop-

down menu.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/media/howtocontextuallookups-2.png
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After the filter has been applied (see the image below), the user can find and select the row as usual.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/media/gridfilteritemlookup.png
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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This topic explains how to change the date for a session. By default, the current date is used when entering and

posting journal entries or source documents. You can change the date that is used for your current session. Use

this feature to back-date journal entries or source documents, as necessary.

1. In the navigation pane, go to Modules > Common > Common > Session date and timeModules > Common > Common > Session date and time.

2. In the DateDate field, enter a date.

3. Select OKOK.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/tasks/change-date-session.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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The following topic explains how a user in the System Administrator role can set the time zone for a user.

1. Go to Navigation pane > Modules > System administration > Users > UsersNavigation pane > Modules > System administration > Users > Users .

2. In the list, find and select the desired record.

3. Select User optionsUser options .

4. Select the PreferencesPreferences  tab.

5. In the Time zoneTime zone field, select an option from the drop-down list.

6. Select SaveSave.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/tasks/set-users-preferred-time-zone.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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LCS workspace for the current versions of the Finance and Operations
apps

Methodologies

This topic is intended for customers who have signed up for the current versions of Finance and Operations

apps. Partners who are working with customers to help them move through the lifecycle of their Lifecycle

Services (LCS) project will also find this information useful.

When you sign up for the current versions of Finance and Operations apps, your subscription includes an

Implementation project workspace. After you activate the service, the tenant administrator must sign in at

https://lcs.dynamics.com by using the tenant account. The project workspace is automatically created for your

organization. The workspace includes the following elements:

Enabled features, based on the offer that you selected

Environments that are deployed and managed by Microsoft

Guidance that is provided through the Action center to help you complete required actions

A new methodology experience that includes tasks that lock as you move through the implementation

A more complete history that specifies who completed each methodology phase and task

Milestones that you can use to track critical project dates

Various services to help you with your implementation

As a customer, you must complete the steps that are outlined in the methodology to gain access to the

production environment. Before a phase can be marked as completed, you must complete the specified

mandatory tasks. Locked tasks, such as tasks 1.6 and 1.9 in the following screenshot, are unlocked after you've

completed the required actions. To learn which actions must be completed before a specific task can be

unlocked, click the lock icon for that task. 

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/lifecycle-services/lcs-works-lcs.md
https://lcs.dynamics.com


Milestones

In the case of prerequisites, after you complete the required tasks, you can mark the dependent tasks as

completed. For example, in the following screenshot, tasks 1.6 and 1.9 depend on task 1.5. Because task 1.5 has

now been completed, the two dependent tasks can be marked as completed. 

High-level milestones must be defined for a project. Milestones can help you track the deliverables that must be

completed and your progress toward the milestone goals. Color indicators help you quickly learn whether

you're behind schedule. For example, in the following screenshot, the milestones are yellow. To enter or update

the milestone dates, click the diamond shape in the methodology, and then click the EditEdit button (pencil icon).

You can change milestone dates at any time.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/media/1.jpg
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When you've finished entering milestones, the Publish plan and milestonePublish plan and milestone task opens, and you can mark it

as completed.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/media/4.jpg
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/media/5.jpg


Methodology description and historyMethodology description and history

When you've completed all the required tasks in a phase, you can click Complete phaseComplete phase to mark the phase as

completed. After you mark a phase as completed, next steps become available in Microsoft Dynamics Lifecycle

Services (LCS).

Descriptions can help you understand what is expected of you for a specific methodology task or phase. You can

expand the methodology description to learn more about each task, and then collapse the description when

you've finished. The task and phase history can tell you when a task or phase was completed or reopened. If

you're a project manager, this information can help you stay on top of the high-level tasks that are required for

your implementations. 

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/media/7.jpg


Subscription estimator

New deployment experience

You can use the Subscription estimator tool to evaluate your subscription requirements for the current versions

of the Finance and Operations apps. To use Subscription estimator, download the usage profile, which is a

Microsoft Excel workbook. Then, in the workbook, complete the following worksheets:

Deployment details

Instance Characteristics

Retail & Commerce

After you've completed the worksheets, enter the data from the summary sheet into Subscription estimator by

clicking + New estimate+ New estimate. You must make one estimate the active estimate. Make sure that the estimate that

you mark as active is same as the offer that you bought through the VL or CSP channel.

To provision your environment, you must to complete a configuration checklist. As you make progress through

the methodology, environments become available to you. Click ConfigureConfigure to add deployment information.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/media/2.jpg
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Because the information that you enter determines your experience, carefully review your input. After you've

entered all the required information, sign-off is required for the deployment request. The user who completes

the sign-off becomes the system administrator on the instance. Verify that the correct user completes the sign-

off for the deployment. After the sign-off is completed, the Microsoft site reliability engagement team reviews

the request. After the team has reviewed the information that you entered, it initiates the provisioning. If the

information isn't correct, the team will contact you. After the provisioning is completed, the status is updated to

indicate that the environment has been deployed, as shown in the following screenshot. If the provisioning takes

longer than expected, the Microsoft site reliability engagement team reviews the status and takes appropriate

actions. These actions might include contacting you. After the environment is provisioned, click Full detailsFull details  to

open the Detailed environmentDetailed environment page, where you can sign in to the system, view the monitoring status, or

view relevant updates.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/media/12.jpg
https://aka.ms/BAG_Docs_Language_Survey
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Programs

Tools

Processes

Frequently asked questions

NOTENOTE

These topics describe the programs, tools, and processes available related to the implementation lifecycle of

your Finance and Operations project.

Microsoft FastTrack

Microsoft Dynamics Lifecycle Services

Lifecycle Services (LCS) for Finance and Operations apps customers

Onboard an implementation project

Prepare for go-live

Go-live for implementation projects FAQ

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/imp-lifecycle/implementation-lifecycle.md
https://aka.ms/D365FastTrackDocs
https://lcs.dynamics.com
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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The Finance and Operations application cloud architecture contains all the elements that are common to all

Microsoft cloud offerings, as described in Subscriptions, licenses, accounts, and tenants for Microsoft's cloud

offerings. Beyond this, it also includes services that automate software deployment and provisioning,

operational monitoring and reporting, and seamless application lifecycle management.

The cloud architecture consists of these conceptual areas:

Subscr iptionSubscr iption – A subscription to Finance and Operations apps gives you an online cloud environment

(or multiple environments) and experience.

L icensesLicenses  – Customers must purchase subscription licenses (SLs) for their organization, or for their

affiliates' employees and on-site agents, vendors, or contractors who directly or indirectly access Finance

and Operations apps. These apps are licensed through Microsoft Volume Licensing and the Microsoft

Cloud Solution Provider (CSP) program. For more information, download the latest Microsoft Dynamics

365 Licensing Guide from Dynamics 365 pricing.

TenantTenant – In Microsoft Azure Active Directory (AAD), a tenant represents an organization. It's a dedicated

instance of the AAD service that an organization receives and owns when it creates a relationship with

Microsoft (for example, by signing up for a Microsoft cloud service, such as Azure, Microsoft Intune, or

Microsoft 365). Every AAD tenant is distinct and separate from other AAD tenants. For more information

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/imp-lifecycle/architecture-overview.md
https://docs.microsoft.com/en-us/office365/enterprise/subscriptions-licenses-accounts-and-tenants-for-microsoft-cloud-offerings
https://dynamics.microsoft.com/pricing/
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about AAD tenants, see How to get an Azure Active Directory Tenant.

A tenant houses the company's user information. This information includes passwords, user profile data,

permissions, and related information. The tenant also contains groups, applications, and other

information that pertains to an organization and its security.

The tenant is created when customers sign up for their first subscription to any Microsoft online service,

such as Microsoft 365, Microsoft Dynamics 365, or Azure. Any later subscriptions to the same online

services or other online services can be grouped within the same tenant.

An organization can have multiple AAD tenants. If there are multiple tenants, make sure that any

subscriptions for Finance and Operations apps are associated with the correct tenant.

Azure Active Director y (AAD)Azure Active Director y (AAD)  – AAD is the multi-tenant, cloud-based directory and identity

management service from Microsoft that combines core directory services, application access

management, and identity protection in a single solution. For more information, see Azure Active

Directory. Finance and Operations apps use AAD as the store for identity. Access to AAD is provided as

part of a subscription to Finance and Operations apps.

Microsoft 365 admin centerMicrosoft 365 admin center  – Microsoft 365 admin center is the subscription management portal

that Microsoft 365 provides for administrators. It's used to provide management functions for users

(AAD) and subscriptions. As part of these management functions, it provides information about service

health. For more information, see About the Microsoft 365 admin center.

You don't have to have an Microsoft 365 license to deploy Finance and Operations apps. However, you might

require a license for specific Office integration scenarios. For more information, see Office integration overview.

Microsoft Dynamics L ifecycle Ser vices (LCS)Microsoft Dynamics L ifecycle Ser vices (LCS)  – LCS is a collaboration portal that provides an

environment and a set of regularly updated services that can help you manage the application lifecycle of

your implementations. For more information, see Lifecycle Services resources. After you purchase and

activate a subscription for a Finance and Operations app, an Implementation projectImplementation project workspace is

provisioned in LCS when the tenant administrator signs in for the first time.

An implementation project is an LCS project for the cloud service. As a Microsoft partner, you can also provision

non-implementation LCS projects for your own purposes. For more information, see Lifecycle Services (LCS) for

Finance and Operations apps partners.

Finance and Operations appsFinance and Operations apps  – Finance and Operations apps are deployed through LCS. Various

topologies are available: development/test/build, acceptance test, performance test, and high-availability

production. For more information about the various topologies, download the latest Microsoft Dynamics

365 Licensing Guide from Dynamics 365 pricing.

Microsoft Azure DevOpsMicrosoft Azure DevOps  – Azure DevOps is used primarily for code version control, development, and

to deploy a build environment. Azure DevOps is also used to track support incidents, such as work items

in Azure DevOps that are submitted to Microsoft through Cloud-powered support, and to integrate the

Business process modeler (BPM) library hierarchy into your Azure DevOps project as a hierarchy of work

items. Azure DevOps is also used during code upgrade.

"Under the hood," Finance and Operations apps use many features of the Azure platform, such as Azure Storage,

networking, monitoring, and Azure SQL Database, to name just a few. Shared services put into operation and

orchestrate the application lifecycle of the environments for participants. Together, Azure functionality and LCS

https://docs.microsoft.com/en-us/azure/active-directory/develop/active-directory-howto-tenant
https://docs.microsoft.com/en-us/azure/active-directory/
https://support.office.com/article/about-the-office-365-admin-center-758befc4-0888-4009-9f14-0d147402fd23
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/lcs
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/getting-started-lcs
https://dynamics.microsoft.com/pricing/
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offer a robust cloud service.

Although many features of the Azure platform are used, you don't have to have an Azure subscription to deploy Finance

and Operations apps in the Microsoft-managed cloud. You must have an Azure subscription only if you want to deploy

Finance and Operations apps cloud-hosted environments in your own Azure subscription.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Microsoft 365 Admin Center

LCS implementation project workspace

This topic describes how to onboard a Finance and Operations project by using Microsoft Dynamics Lifecycle

Services (LCS).

After your organization has purchased a subscription to Finance and Operations, it must be activated on your

organization's Azure Active Directory (Azure AD) tenant by your Tenant Administrator, who completes the

following steps:

NOTENOTE

NOTENOTE

1. Open an InPrivate/Incognito browser session and go to the Microsoft 365 Admin Center.

2. Sign in with the Tenant Administrator credentials.

3. Go to Billing > Products & ser vicesBilling > Products & ser vices  and confirm that there is an active subscription for the

application that you want to deploy.

If you do not see an active subscription, consult with your Licensing Partner to confirm the status of the

subscription transaction as well as the tenant for the subscription. By default, all Microsoft Online Services should

be running on the same Azure AD tenant.

4. If the subscription in question is shown as active, proceed to the next step by signing in to LCS to trigger

the Implementation Project creation flow.

5. Open another private browser tab and go to Lifecycle Services. Select LoginLogin to access LCS with your

current Tenant Admin credentials.

6. Accept and confirm any other prompts displayed to complete the Implementation Project provisioning.

7. The Tenant Administrator is assigned the Project Owner security role in the provisioned Implementation

Project.

If the Tenant Administrator will not be a participant in the implementation, at least one additional Project Owner

must be assigned to the implementation project.

For an overview of LCS user management, including the security roles that can be assigned to users, see

Configure Lifecycle Services (LCS) security.

After the Tenant Administrator has completed the Finance and Operations subscription activation and added

additional project owners as appropriate, those team members can access the ImplementationImplementation

projectproject workspace.

The first step to be completed in LCS is Project onboardingProject onboarding. This step is required for all LCS implementation

projects that are created on or after August 22, 2019, PSTon or after August 22, 2019, PST, prior to deploying any of the Microsoft-managed

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/imp-lifecycle/onboard.md
https://admin.microsoft.com/
https://lcs.dynamics.com
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/configure-lcs-security


FastTrack onboarding services
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Key data to keep current in LCS

NOTENOTE

environments. You can access the Project onboardingProject onboarding feature using the action center notification or the LCS

Implementation project menu. You must be assigned to the Project owner security role to access ProjectProject

onboardingonboarding in LCS.

To get started with LCS, see Lifecycle Services (LCS) for Finance and Operations apps customers.

After the LCS Implementation projectImplementation project workspace is provisioned, the Microsoft FastTrack team will monitor

your onboarding progress. If project onboarding is not completed within a few weeks after creating an LCS

Implementation projectImplementation project, a reminder will be sent to the project team.

For more information about the FastTrack program and the services provided, see Microsoft FastTrack.

For more information about LCS project onboarding, see LCS project onboarding.

All onboarding-related emails from the FastTrack team will originate from Dynamics 365 Onboarding

(ond365@microsoft.com), so please ensure that any spam blocker/filter allows email from this address.

We recommend that you add key project members (such as project managers) from the customer and partner

teams to the LCS implementation project. Be sure to include each person's work email address. In this way, you

help us work best with you and help ensure that project members don't miss important communication from

us.

Be sure to keep the milestone dates in your LCS project current. In this way, you help us connect with you at

different project stages. When you're closer to your go-live date, we will contact you for a project Go-live

assessment before we deploy your production environment.

Milestone dates are stored in the LCS implementation methodology. For more information, see the

Methodologies section of the "LCS for Customers" topic.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/fasttrack-dynamics-365-overview.html
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Environment planning overview

Environment typesEnvironment types

IMPORTANTIMPORTANT

Tier-1 vs. Tier-2 and higherTier-1 vs. Tier-2 and higher

T IER-1T IER-1 T IER-2 A N D H IGH ERT IER-2 A N D H IGH ER

Single-box environment Multi-box environment

This topic provides an overview of various aspects that you must consider while you plan for your project's

environment. To help guarantee a successful cloud implementation, it's important that you discuss and plan

your environment early in the project.

To begin, here are a few important concepts:

Environment purposeEnvironment purpose – The reasons why the environment exists. Examples include development, system

testing, user acceptance testing (UAT), and operations.

Environment topologyEnvironment topology  – The composition of the environment and the purpose. Examples include

DevelopDevelop and Build and TestBuild and Test for Tier-1 environments.

Environment tierEnvironment tier  – The type or category of the environment. Examples include Tier-1 environments and

Tier-2 environments.

For more information, about the various environments and tiers, see Cloud deployment overview and download

the latest Microsoft Dynamics 365 Licensing Guide from Dynamics 365 pricing.

You can use the following environment types for your project:

StandardStandard – This environment is included in the standard offer and is managed by Microsoft in a Microsoft

subscription. Standard environments include the production environment and a Tier-2 Standard Acceptance

Test environment.

Add-onAdd-on – The add-on environments are in a Microsoft-managed subscription that the customer has

purchased in addition to the standard offer. For example, an add-on environment might be an additional Tier-

4 environment for performance testing.

Cloud-hostedCloud-hosted – Cloud-hosted environments are additional environments that are managed by the

customer or partner in a customer or partner Microsoft Azure subscription. A cloud-hosted environment can

include a Tier-1 demo environment.

Environment image (VHD)Environment image (VHD)  – These additional Tier-1 environments are hosted on-premises by using a

virtual hard disk (VHD) that can be downloaded from Microsoft Dynamics Lifecycle Services (LCS).

In a customer or partner Azure subscription, the customer or partner brings its own Azure subscription, and deploys

environments to that subscription for evaluation and development purposes only. The customer or partner pays for the

resources that are deployed to its Azure subscription. The amount that the customer or partner pays is based on the

Azure price list. By contrast, in a Microsoft subscription, the customer purchases licenses that allow the customer to

deploy environments to an Azure subscription that is managed by Microsoft. Therefore, the customer has no separate

Azure billing.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/imp-lifecycle/environment-planning.md
https://dynamics.microsoft.com/pricing/
https://lcs.dynamics.com/v2


All components are installed on the same server. These
components include Application Object Server (AOS), the
database, Dynamics 365 Commerce, and Management
Reporter.

Components are installed on multiple servers.

Microsoft SQL Server is used. Azure SQL Database is used.

The architecture differs from the architecture of the
production environment to maximize efficiency and cost of
the development team.

The architecture is the same as the architecture of the
production environment, even though this type of
environment has a different sizing and isn't enabled for
disaster recovery.

The environment can be cloud-hosted, or it can be deployed
as an environment image (VHD).

The environment can be deployed only as a standard
environment or an add-on environment. It can't be cloud-
hosted.

The environment isn't suitable for UAT or performance
testing.

The environment is suitable for UAT and performance
testing.

T IER-1T IER-1 T IER-2 A N D H IGH ERT IER-2 A N D H IGH ER

Standard cloud offer

IMPORTANTIMPORTANT

Provisioning of standard environmentsProvisioning of standard environments

The standard cloud offer includes two environments:

Tier-2 environment: Standard Acceptance TestingTier-2 environment: Standard Acceptance Testing – One Standard Acceptance Testing (UAT)

instance is provided for the duration of the subscription. This instance is a non-production multi-box

instance that customers can use for UAT, integration testing, and training. Additional sandbox/staging

instances can be purchased separately as an optional add-on.

Production environmentProduction environment – One production instance is provided per tenant. The production multi-box

instance includes disaster recovery and high availability. It will be provisioned when the implementation

approaches the Operate phase, after the required activities in the Microsoft Dynamics Lifecycle Services

(LCS) methodology and a successful go-live assessment are completed. Additionally, some file storage

and database storage are included in the offer :

File storage:File storage: Every customer receives a certain amount of file/Azure blob cloud storage for files and

binary data. Additional file/blob storage can be purchased.

Database storage:Database storage: Every subscription includes a certain amount of Azure SQL Database storage per

customer at no additional charge. Additional storage capacity is provided at no charge as an

organization increases the number of user and device service licenses. For more information about

the various environments and the various types of storage, as well as the currently included free file

and storage capacity, download the latest Microsoft Dynamics 365 Licensing Guide from Dynamics

365 pricing.

Microsoft promises service and data high availability as well as minimal servicing downtime guarantees as part of the

Dynamics 365 software license agreement (SLA) for production environments. The SLA goals do not apply to non-

production environments.

The standard environments are provisioned at different times. The following table shows the suggested timing

for the environments in the standard cloud offer.

https://docs.microsoft.com/en-us/azure/sql-database/
https://dynamics.microsoft.com/pricing/
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Tier-2 Standard Acceptance Test Immediately after project onboarding
has been completed in LCS

Yes

Production At production system readiness A Go-live assessment must be
completed prior to configuring the
production deployment request in LCS.

IMPORTANTIMPORTANT

Production system readinessProduction system readiness

Additional environments

Always deploy environments by using an unnamedunnamed account. This account must be from the customer domain, such as 

dynadmin@customer.com  or dynadmin@customer.onmicrosoft.com . We strongly recommend using the same dedicated

environment admin account on all environments. ISV licenses must be issued to the domain of the account used for

environment deployment, therefore using both dynadmin@customer.com  and dynadmin@customer.onmicrosoft.com  on

different environments can lead to problems with ISV licenses.

The production environment can be deployed when the project is ready for the initial go-live. For more

information, see Prepare for go-live.

Production system readiness includes, but isn't limited to, the following conditions:

An up-to-date subscription estimate is activated, as described in Subscription estimator in Lifecycle Services

(LCS).

Code, configuration, and data are ready for cutover.

An engineering process is in place to manage critical fixes.

The customer has signed off on the solution and UAT.

A cutover plan is in place.

Customers should use the production environment to operateoperate the solution, not build it. The production

environment is sized to run your business. The sizing is based on the subscription estimate and diagnostic data

from performance testing. After deployment, customers can and should do a mock cutover and a final round of

validation on the production environment. Before the final cutover, customers can request a Point in time restore

to restore the production environment to a clean snapshot (maximum 28 days in the past).

To select the appropriate data center for the production environment, consider the latency from the geographic

locations where the business operates. Use tools such as PsPing and Azure Speed Test to test latency to Azure

data centers.

The following illustrations shows the environment planning process.

Additional environments can be purchased as add-ons, or they can be deployed as cloud-hosted environments.

The following illustration shows a sample overview of standard and additional environments, based on the

complexity of the implementation.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/subscription-estimator
https://docs.microsoft.com/en-us/sysinternals/downloads/psping
https://azurespeedtest.azurewebsites.net/
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Deployment considerations for development environmentsDeployment considerations for development environments

NOTENOTE

C A PA B IL IT YC A PA B IL IT Y C LO UD-H O ST EDC LO UD-H O ST ED EN VIRO N M EN T  IM A GEEN VIRO N M EN T  IM A GE

Public URL ✓ Not supported

Integration development ✓ Extra setup is required. (For example,
run the admin user provisioning tool.)

Azure DevOps ✓ Extra setup is required. (For example,
rename the computer.)

Applying deployable packages from
LCS

Automated Command line runbooks
(AxUpdateInstaller.exe tool)

Deploying data packages from LCS ✓ Not supported

Maintenance Managed by the customer/partner Managed by the customer/partner

Always deploy environments by using an unnamedunnamed account, such as dynadmin@customer.com . Assign the environments

an owner who will be responsible for their status and maintenance. We strongly recommend using the same dedicated

environment admin account on all environments. After go-live, if you plan to work on new releases, get an additional Tier-

2 or higher environment to support production.

For development environments, there are two deployment options:

Cloud-hostedCloud-hosted – The environments are managed by the customer/partner in a customer/partner Azure

subscription.

Environment image (downloadable VHD)Environment image (downloadable VHD)  – The environments are hosted on-premises.

You must allocate one development environment per developer.

The following table compares the deployment options.



Cost model Pay as you go (If the environment is
on for eight hours, you pay for eight
hours.). Cost is based on selected
Virtual Machine size, disk size and
settings, and premium storage settings

Hardware-related

Limitations None. You have full control over VM
specs, disk size and storage settings.
You have administrator access to the
VM.

None

C A PA B IL IT YC A PA B IL IT Y C LO UD-H O ST EDC LO UD-H O ST ED EN VIRO N M EN T  IM A GEEN VIRO N M EN T  IM A GE

Selecting the correct Tier-2 or higher environmentSelecting the correct Tier-2 or higher environment

Purchasing add-on environmentsPurchasing add-on environments

It's important that you select the correct Tier-2 or higher environment, depending on the purpose of the

environment. The guidance that is provided in the following illustration is a baseline. You must work with your

implementation partner to adjust this guidance, based on your specific business scenarios and factors such as

type of users, complexity, and volumes.

After a subscription estimate is activated, you can view transaction lines per hour in LCS, as shown in the

following illustration.

If you want to purchase add-on environments, we recommend that you work closely with your Cloud Solution

Provider or License Service Reseller. Consider the potential lead time that occurs between the time when the

order is placed and the time when the environment is deployed.

The following illustration shows the process for purchasing add-on environments.



IMPORTANTIMPORTANT

Environments plan

NOTENOTE

If you have a Microsoft Volume Licensing agreement, you can subscribe to add-on environments on a monthly basis

through the Microsoft Products and Services Agreement (MPSA) licensing program. Alternatively, you can subscribe to

them through the Microsoft Cloud Solution Provider (CSP) program. For more information about the various

environments and tiers, download the latest Microsoft Dynamics 365 Licensing Guide from Dynamics 365 pricing.

Create the environments plan early in your implementation.

1. Identify the project activities that require an environment. These activities include, but aren't limited to,

development of customizations and maintenance of golden configuration data.

2. Determine the activities lifecycle to determine the environments lifecycle. Here are some examples of the

questions that you should ask during this step:

When and for how long do you require the environment?

Do you require the environment before or after go-live?

3. Determine the type and topology of the required environments.

4. Summarize the list of required environments in a matrix.

After you've identified the environments, the environments plan can be used to structure the Application

Lifecycle Management (ALM) flows. For example, after you finalize your environments plan, you can define the

flows for building and moving the code and the data across environments.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://dynamics.microsoft.com/pricing/
https://aka.ms/BAG_Docs_Language_Survey
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P H A SEP H A SE A C T IO NA C T IO N
EN VIRO N M EN TEN VIRO N M EN T
T Y P ET Y P E

DURAT IO N / W H EDURAT IO N / W H E
NN W H OW H O N OT ESN OT ES

1 Update Go-live
date in LCS

Both At the latest 2-3
months in
advance

Customer/Partne
r

The milestone
dates should be
kept up to date
on an ongoing
basis.

2 Complete and
send pre go-live
checklist

Both After user
acceptance
testing (UAT)
complete

Customer/Partne
r

Follow the
instructions
provided in the
"FastTrack Go-
live Assessment"
section later in
this topic.

This topic describes how to prepare to go live with a project by using Microsoft Dynamics Lifecycle Services

(LCS).

Production and Sandbox can only be deployed in two different types of environments: Microsoft Managed or

Self-Service. Both follow the same preparation for go-live, but the service level agreements (SLA) and some of

the process steps are different.

This graphic and the following table list the phases of the go-live process, the environment type to which each

phase applies with the expected duration, and who is responsible to take the action.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/imp-lifecycle/prepare-go-live.md


3 Project Go-Live
assessment
(FastTrack
Essentials)

Both 3-business days
for initial report,
plus additional
time for
mitigation, if
required

Microsoft-
FastTrack
Solution
Architect

Solution
Architect delivers
assessment after
checklist is
received and
continues review
until questions
are clarified and
mitigations are in
place, if
applicable.

Go-live
Assessment
workshop
(FastTrack)

Both To coordinate
with architect
assigned

Microsoft-
FastTrack
Solution
Architect

4 Release for
production
deployment

Microsoft
Managed

Immediate upon
successfully
completed
assessment

Microsoft-
FastTrack
Solution
Architect

Do not submit
production
request until the
assessment is
successfully
completed.

Self-Service Immediate upon
successfully
completed
assessment and
ConfigureConfigure
button is
enabled

Microsoft-
FastTrack
Solution
Architect

For Self-Service
deployment, the
ConfigureConfigure
button remains
disabled until the
assessment is
complete.

5 Production
deployment
request

Microsoft
Managed

Self-service Customer/Partne
r

The production
deployment
request should
only be
submitted after
the FastTrack
Architect has
finished the
assessment.

Self-Service Self-service Customer/Partne
r

After the
assessment is
complete, the
ConfigureConfigure
button will be
enabled and
customer will be
able to request
the production
deployment.

P H A SEP H A SE A C T IO NA C T IO N
EN VIRO N M EN TEN VIRO N M EN T
T Y P ET Y P E

DURAT IO N / W H EDURAT IO N / W H E
NN W H OW H O N OT ESN OT ES



Sizing Both Immediate in
case of
automatic sizing.
Could require
further
clarifications of
the subscription
estimate.

Microsoft-
Dynamic Service
Engineering
(DSE)

Automatic sizing
based on
subscription
estimate by
default, manual
sizing by
exception.

Deployment Microsoft
Managed

48 hours Microsoft-
Dynamic Service
Engineering
(DSE)

Status in LCS
reflects the
deployment
progress. If there
are any
questions about
your request,
they will be
posted as
Comments on
the service
request.

Self-Service An average of 30
minutes

Microsoft-
FastTrack
Solution
Architect

The deployment
could take an
average of 30
minutes after the
assessment has
completed and
the production
environment has
been requested.
For more
information, see
Deploy a new
environment.

6 Deployable
package
installation
request

Both Self-service Customer/Partne
r

Follow the
instructions in
Apply updates.
The packages
must contain all
the models and
binaries
consolidated in
an All-in-one
deployable
package.

P H A SEP H A SE A C T IO NA C T IO N
EN VIRO N M EN TEN VIRO N M EN T
T Y P ET Y P E

DURAT IO N / W H EDURAT IO N / W H E
NN W H OW H O N OT ESN OT ES

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/deployenvironment-newinfrastructure
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/updateenvironment-newinfrastructure
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-tools/aio-deployable-packages


Package
installation

Both Minimum 5
hours lead time
and 4 hours
downtime

Microsoft-
Dynamic Service
Engineering
(DSE)

Generally, 95% of
updates are
applied in less
than one hour,
however we still
recommend that
you provide a
downtime
window of four
hours in case a
rollback is
required for any
reason. When
the package
deployment
succeeds, the
environment will
be available as
soon as the
package
deployment has
finished, which
means that the
longer downtime
window does not
have any
negative effect
on the
availability of the
system.

7 Database copy
from Sandbox
request (if
applicable)

Both Self-service Customer/Partne
r

Follow the
instructions Self-
service database
refresh. If you
have a golden
configuration
you can review
Golden
configuration
promotion.

Copy database Both Five hours lead
time and four
hours downtime

Microsoft-
Dynamic Service
Engineering
(DSE)

Generally, the
database copy is
completed in less
than one hour.
We still
recommend that
you provide a
downtime
window of four
hours in case a
rollback is
required for any
reason.

P H A SEP H A SE A C T IO NA C T IO N
EN VIRO N M EN TEN VIRO N M EN T
T Y P ET Y P E

DURAT IO N / W H EDURAT IO N / W H E
NN W H OW H O N OT ESN OT ES

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/database/database-refresh
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/database/dbmovement-scenario-goldenconfig


8 Production ready Both After all previous
steps have been
completed

Customer/Partne
r

Customer can
take control of
the production
environment.

Cutover activities Both Depends on the
project

Customer/Partne
r

9 Go live Both Depends on the
project

Customer/Partne
r

P H A SEP H A SE A C T IO NA C T IO N
EN VIRO N M EN TEN VIRO N M EN T
T Y P ET Y P E
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Completing the LCS methodology

NOTENOTE

UAT completion and solution sign off

A major milestone in each implementation project is the cutover to the production environment.

To ensure that the production environment is used for live operations, Microsoft will provision the production

instance only when the implementation is approaching the OperateOperate phase, after the required activities in the

LCS methodology are complete. For more information about the environments in your subscription, see the

Licensing guide.

Customers must complete the AnalysisAnalysis , Design and DevelopDesign and Develop, and TestTest phases in the LCS methodology

before the ConfigureConfigure button that is used to request the production environment becomes available.

For Self-Service environments, the ConfigureConfigure button will only become available after the Solution Architect has signed off

on the assessment.

To complete a phase in LCS, you must first complete every required step in that phase. When all the steps in a

phase are completed, you can complete the whole phase. You can always reopen a phase later if you must make

changes. If you require more help, see Lifecycle Services (LCS) for Finance and Operations apps customers.

The process of completing a step has two parts:

Do the actual work, such as a fit-gap analysis or user acceptance testing (UAT).

Mark the corresponding step in the LCS methodology as completed.

It's good practice to complete the steps in the methodology as you make progress with the implementation.

Don't wait until the last minute. Don't just click through all the steps so that you can get a production

environment. It's in the customer's best interest to have a solid implementation.

During the UAT phase, you must test all the business processes that you've implemented, and any

customizations that you've made, in a Sandbox, or Standard Acceptance Test, environment in the

implementation project. To help ensure a successful go-live, you should consider the following as you complete

the UAT phase:

Test cases cover the entire scope of requirements.

Test by using migrated data. This data should include master data and opening balances, even if they aren't

yet final.

Test by using the correct security roles (default roles and custom roles) that are assigned to users.

https://go.microsoft.com/fwlink/?LinkId=866544&clcid=0x409


FastTrack Go-live assessment

Make sure that the solution complies with any company-specific and industry-specific regulatory

requirements.

Run the Customization Analysis Report (CAR) and resolve critical issues.

Complete performance testing.

Document all features, and obtain approval and sign-off from the customer.

Regardless of whether the environment is a cloud-hosted environment or a downloaded virtual hard disk (VHD),

testing can't be considered complete when you test only in an environment that is a developer or demo

topology. Here are the reasons:

The topology of the Tier-1 environments differs from the topology of your production environment. It's

important that you test all functionality on a Tier-2 or higher sandbox environment in the Microsoft-

managed subscription. It's especially important that you test integrations, printing functionality, workflow

functionality, and warehouse and commerce devices in the sandbox environment.

System performance can't be measured when you do the UAT on local virtual machines (VMs) or VMs that

are privately hosted.

To prevent delays during the cutover process, it's important that the team experience the servicing in LCS

during the implementation. This servicing includes the processes of applying deployable packages, creating

service requests, and moving database between environments.

All customers must complete a go-live review with the Microsoft FastTrack team before their production

environment can be deployed. This assessment should be successfully completed before you request your

production environment. If you aren't familiar with Microsoft FastTrack, see Microsoft FastTrack.

About eight weeks before go-live, the FastTrack team will ask you to fill in a go-live checklist.

You can download the checklist from Dynamics 365 CommunityDynamics 365 Community  on the Go-live Planning TechTalk page.

The project manager or a key project member must complete the go-live checklist during the pre-go-live phase

of the project. Typically, the checklist is completed four to six weeks before the proposed go-live date, when UAT

is completed or almost completed.

When you've completed the go-live checklist, email it to Dynamics 365 FO Go-LiveDynamics 365 FO Go-Live

d365fogl@microsoft.com. Always include a key stakeholder from the customer and the implementation partner

on the email.

After the checklist is submitted, a Microsoft solution architect will review the project and provide an assessment

that describes the potential risks, best practices, and recommendations for a successful go-live of the project. In

some cases, the solution architect might highlight risk factors and ask for a mitigation plan. When the

assessment is completed, the solution architect will indicate that you're ready to request the production

environment in LCS.

For Microsoft Managed environments, if you request the production environment before the assessment is

completed, the deployment will remain in the QueuedQueued state until the assessment is successfully completed. For

Self-Service environments, the ConfigureConfigure button to request production will be only enabled after the

assessment is completed.

You can cancel an environment deployment request while it is in a QueuedQueued state by following these steps:

1. Select QueuedQueued.

2. On the Customer sign-offCustomer sign-off  tab, select Clear sign-offClear sign-off .

This will set the environment back into a state of ConfigureConfigure and allow you to make changes to the

configuration, such as selecting a different data center or environment topology.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-tools/customization-analysis-report
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/fasttrack-dynamics-365-overview.html
https://aka.ms/FastTrackPreGoLiveChecklist


Requesting the production environment

NOTENOTE

NOTENOTE

The production environment is used exclusively for running your business operations and shouldn't be used for testing.

You will be able to perform the cutover, and if planned, to mock the cutover in production. To test the solution, you must

use a UAT environment, which is designed with the necessary elements and services for testing.

After you've completed the analysis, design and develop, and test phases in the LCS methodology, and the go-

live assessment has concluded that the project is ready, you can request your production environment.

We recommend that you select a service account, for example a generic user account, as the Admin user of the

environments that you deploy. If you use a named user account, you might not be able to access an

environment if that user isn't available. Here are some scenarios where the Admin user must access an

environment:

First sign-in to any environment after initial deploymentFirst sign-in to any environment after initial deployment – In this case, the Admin user is the only

user who can access the environment.

First sign-in to a sandbox environment after a database refresh from the productionFirst sign-in to a sandbox environment after a database refresh from the production

environmentenvironment – In this case, all user accounts except the Admin account are unable to sign in.

Your production environment should be deployed to the same datacenter where your sandbox environments

are deployed.

After you've signed off on the request for the production environment, Microsoft is responsible for deploying

the production environment for you. For Microsoft ManagedMicrosoft Managed environments, the Microsoft service level

agreement (SLA) for deployment of a production environment is 48 hours. The production environment can be

deployed at any time within 48 hours after you submit the request, provided that your usage profile doesn't

require additional information. For Self-Ser viceSelf-Ser vice environments, the deployment will take around 30 minutes

after the production request has been submitted. You can view the progress of the deployment in LCS. Typically,

the status of the production environment request remains QueuedQueued for a few hours before it's changed to

DeployingDeploying.

When you submit the deployment request, a service request for the Microsoft Dynamics Service Engineering

(DSE) team is automatically created. You can view this service request in the Ser vice requestsSer vice requests  list in LCS. If the

DSE team has questions that prevent them from deploying the production environment, they will add a

comment to the service request. For example, the DSE team might ask that you update the subscription estimate

or change the datacenter. In some cases, you might have to clear the sign-off from the production deployment

request to make changes.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Go-live for implementation projects FAQ
2/18/2021 • 5 minutes to read • Edit Online

When can I configure and request my production environment?

What are the prerequisites to deploy a production environment?

What is a Go-live assessment/review, and why is it required?

I want to request my production environment. Who do I contact for a
Go-live assessment/review?

The Production button isn't available in LCS. How do I request my
production environment?

NOTENOTE

My sandbox environment is currently on an update that is set to
expire in two months. Can I request a production environment that
has the latest update?

This topic lists frequently asked questions about how to go live with an implementation project.

Typically, a production environment is deployed after all customizations are code-complete, user acceptance

testing (UAT) is completed, the customer has signed off on the solution, and there are no blocking issues for go-

live.

When you're at this stage, the Microsoft FastTrack team will work with the project team to do a Go-live

assessment/review.

For a list of the prerequisites, see Prepare for go-live.

The Go-live assessment/review is part of the Microsoft FastTrack program. During this review, a solution

architect assesses whether an implementation project is ready for a successful cutover and go-live. This review

is mandatory for every implementation project before you can request to go live in a production environment.

If a FastTrack solution architect is assigned to your project, contact him or her directly. Otherwise, based on the

go-live date that is specified in Microsoft Dynamics Lifecycle Services (LCS), you will receive an email that

instructs you to fill out the Pre-go-live checklist and send it to d365fogl@microsoft.com a few weeks before the

go-live date. If you haven't received an email, and you're ready for go-live, you can download the checklist from

Dynamics 365 CommunityDynamics 365 Community  on the Go-live Planning TechTalk page, complete it, and send it to

d365fogl@microsoft.com.

The ProductionProduction button in LCS is available only after you've completed the AnalysisAnalysis , Design & developDesign & develop, and

TestTest phases of the LCS implementation methodology. For more information about how to complete these

phases, see Lifecycle Services (LCS) for Finance and Operations apps customers.

Your production environment won't be deployed until the Go-live assessment/review has been completed.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/imp-lifecycle/go-live-faq.md
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/fin-ops/get-started/fasttrack-dynamics-365-overview.html
mailto:d365fogl@microsoft.com
https://aka.ms/FastTrackPreGoLiveChecklist


Our sandbox environments are deployed in the Central US
datacenter, but we want our production environments to be deployed
in the West US datacenter. Can I select West US as the datacenter in
my production configuration?

How will my production environment be sized?

NOTENOTE

I submitted the request for a production environment, but I made a
mistake. Can I still change it?

How long does it take to deploy my production environment?

What level of access do I have in my production environment? Can I
sign in to the VM?

How often is my production database backed up?

No. We will deny any request for a production environment that is on a different version than your sandbox

environment. When you configure a production environment, the versions that you select must match the

versions of the sandbox environment where you signed off on your solution. Therefore, you must first apply the

latest update to your sandbox environment, test it, and sign off.

For more information, see Software lifecycle policy and cloud releases.

No. We will deny any request for a production environment that is in a different datacenter than your sandbox

environment. We require that all your environments reside in the same datacenter. If you want your production

environment to reside in the West US datacenter, you must first redeploy your sandbox environments to the

West US datacenter, test them, and sign off.

For information that can help you select the correct datacenter, see the Network requirements section of the

"System requirements" topic.

Your production environment will be sized based on the current user license count and the information in the

subscription estimate that is active when you request the production environment.

If you add additional users later, you must create a support ticket to activate a new subscription estimate. Your

production environment might have to be resized, depending on the number of users, the type of user licenses, and the

expected peak transaction volume. Downtime is required in order to resize a production environment.

Yes. As long as the status of the production environment is QueuedQueued, you can clear the sign-off flag, make

changes, and then sign off again.

After the Go-live assessment with the Microsoft FastTrack team is completed and the production request is

submitted, deployment of the production environment should be completed within 48 hours.

No. Access to the production environment is limited. You can't access the virtual machine (VM) or Microsoft

Internet Information Services (IIS). You also can't access the database through Microsoft SQL Server

Management Studio.

Databases are protected by automatic backups. Full database backups are done weekly, differential database



Can I request a copy of the backup of my production database?

My golden configuration database is in a Tier 1 sandbox environment.
How can I copy and restore it to my production environment?

NOTENOTE

After go-live, can I apply new code changes to the production
environment?

What should I do if my production environment is down?

NOTENOTE

backups are done hourly, and transaction log backups are done every five minutes. Automatic backups are

retained for 35 days.

For more information, see Learn about automatic SQL Database backups.

No. However, you can submit a database refresh service request to copy your production database to your Tier 2

and higher sandbox environment. After the copy request is completed, you can back up your sandbox

environment.

To copy and restore your database, follow the instructions in the topic, Golden configuration promotion.

If your golden configuration is in data packages, you must manually import the data packages to the production

environment.

Yes. In LCS, you can submit a service request to apply a deployable package to your production environment.

Application of one deployable package to a production environment involves a lead time of five hours and

downtime of approximately five hours.

For more information, see Apply updates to cloud environments.

To report a production outage, follow the process described in the topic, Report a production outage.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/azure/sql-database/sql-database-automated-backups
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/database/dbmovement-scenario-goldenconfig
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/report-production-outage
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Submit service requests to the Dynamics Service
Engineering team
2/18/2021 • 7 minutes to read • Edit Online

NOTENOTE

View service requests

A service request is a ticket that you use to request that the Dynamics Service Engineering (DSE) team perform a

predefined set of tasks on your environments.

Don't use service requests for product issues. If you encounter a situation that doesn't fit into any of the tasks that are

described in this topic, submit a support ticket instead. For more information about support tickets, see Get support for

Finance and Operations apps or Lifecycle Services (LCS).

You can use Microsoft Dynamics Lifecycle Services (LCS) to submit service requests directly to the DSE team.

You can also view which requests have been submitted, executed, and canceled for your environments.

There are two ways to view service requests:

On the project dashboard, in the EnvironmentsEnvironments  section, select Ser vice requestsSer vice requests .

Select the MenuMenu button and select Work itemsWork items . On the Work itemsWork items page select the Ser vice requestsSer vice requests

tab.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/lifecycle-services/submit-request-dynamics-service-engineering-team.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/lcs-support


Create service requests

Automatically create a service requestAutomatically create a service request

By default, the Ser vice requestsSer vice requests  tab on the Work itemsWork items page lists all requests that are currently active and

requests that have been denied. However, you can use the filter options to show canceled and finished requests

too.

After you submit a request, it has a status of RequestedRequested. Before the DSE team acts on the request, it might ask

for clarification by entering a comment in the CommentComment field. For example, you might receive a comment from

the DSE team if you request deployment of a production environment, but the data center differs from the data

center where your sandbox environments are deployed. Carefully review the comments, and provide any

required clarification in your own comment. To view the details of a specific request, or to submit comments for

a service request, select the request ID.

If you signed up for LCS notifications, you receive an email when the status of a service request changes or a

comment is entered.

If you submit a service request to the DSE team, and the action is outside the team's scope, the service request

will be denied. In this case, the reason for the denial and suggestions for further action are provided. For some

typical examples of service requests that the DSE team will deny, see the "Denied service requests" section later

in this topic.

There are two ways to create a service request: automatically and on demand.

AutomaticallyAutomatically  – A service request is automatically created when you request deployment of an

environment, or an application of a package.

On demandOn demand – A service request is manually created when you enter a request for a database point-in-time

restore, and some other services.

Environment deploymentEnvironment deployment – To set up deployment options and submit a request to the DSE team to

deploy a new environment, in the EnvironmentsEnvironments  section, select ConfigureConfigure.

Package applicationPackage application – To apply a package to the production environment, on the EnvironmentEnvironment

detailsdetails  page, select MaintainMaintain , select the package to apply, and then select ScheduleSchedule. For more

information, see Apply updates to cloud environments.



Create a service request on demandCreate a service request on demand

IMPORTANTIMPORTANT
If your scheduled time overlaps with a planned maintenance window, you will receive the following warning

message.

If you choose to continue deploying the package, the package deployment operation will be rolled-back in the

event of conflict, as planned maintenance takes priority.

This restriction is appliable to Microsoft-managed IAAS environmentsMicrosoft-managed IAAS environments only.

Service requests that are created on demand aren't explicitly accepted by the DSE team. They will be addressed

during the specified downtime window unless the DSE team has entered a comment in the request or has had

to deny the request. For details, review the comments in the service request.

Microsoft frequently reviews all incoming service requests. By selecting the correct type of service request for

your scenario, you help the DSE team handle the request in a timely manner.

1. On the Work itemsWork items page, on the Ser vice requestsSer vice requests  tab, select AddAdd.

2. In the Create requestCreate request dialog box, select the type of service request to create. The options on the page

then reflect the specific type of request that you selected.

NOTENOTE

NOTENOTE

Sandbox point-in-time restore requestSandbox point-in-time restore request – Select this request type to restore a non-production

database to a specific point in time. For more information, see Database movement operations

home page.

If you need to restore a production database to a previous point-in-time during the cutover phase, select

the Production point-in-time restore requestProduction point-in-time restore request  type. If you need to restore a production database

when you're already live in operations, submit a support ticket through LCS.

Database refresh requestDatabase refresh request – Select this request type to refresh a database from a production

environment to a sandbox environment, or from one sandbox environment to another. For more

information, see Refresh database. This request type is being retired on January 31, 2019.

If you need to refresh a database from a sandbox environment to a production environment during the

cutover phase, select the Sandbox to ProductionSandbox to Production type.

Sandbox to ProductionSandbox to Production - Perform a database refresh of your configuration data to a production

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/planned-maintenance-window-faq
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/database/dbmovement-operations
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/database/database-refresh


Commonly denied service requestsCommonly denied service requests

Service request types and SLAs
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environment during the cutover phase. For more information, see Database movement operations

home page.

Other requestOther request – You need to use the Other requestOther request type exactly as described here. If you word a

request in a way that isn't clear to the DSE team, the team will enter a comment to ask for

clarification, and your request will be delayed. If you use the Other requestOther request type for any request

that isn't listed below, the request will be denied. Select this request type to request that the DSE

team perform one of the following actions:

NOTENOTE

Turn on maintenance mode in a production environment. For more information, see

Maintenance mode.

Tenant move of a live Production environment. Request the Microsoft Service Engineering

team to move the Production database and Azure Blob Storage from the old tenant to the

new tenant if you are moving tenant on a live Production environment. Make sure that you

only request this service when you are ready with all prerequisites. For more details, see

Move LCS implementation projects to different Azure AD tenants.

Define explicit Internet Protocol (IP) safe list rules in a production environment.

Support for explicit safe list rules is deprecated for self-service environments. For more information,

see Removed or deprecated platform features.

Request that Microsoft Power BI Embedded be activated in a sandbox environment,

Standard Acceptance Test environment, or production environment if you receive the

following message: "Power BI embedded isn't enabled. Please contact your system

administrator."

Here are some typical examples of service requests that will be denied:

You submit a request of the Other requestOther request type for one of the following actions, but you should have

submitted a support ticket instead:

You want to activate a new subscription estimate after you're live in production or after you've

requested a production environment.

You want to reset the Financial reporting data mart in a release that is earlier than Microsoft Dynamics

365 for Finance and Operations Financial reporting release 7.2.6.0.

You want to restore a production database after go-live.

You encountered an issue after the DSE team did an application upgrade.

You submit a request of the Other requestOther request type for an action that you should have requested through a

different request type. Examples include a database refresh in a non-production environment.

You submit a request of the Other requestOther request type for an action that you should perform yourself.

Examples include a database upgrade in a development environment.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/database/dbmovement-operations
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/sysadmin/maintenance-mode
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/get-started/removed-deprecated-features-platform-updates


Environment
deployment

Any Environment
deployment

Service level
agreement (SLA):
within two business
days

Package application Production Deployable package
application

Five hours Five hours

Sandbox point-in-
time restore

Any Tier 2 or higher
sandbox

Database point-in-
time restore

Five hours Four hours

Production point-in-
time restore

Production Database point-in-
time restore

Based on data
volume

Based on data
volume

Sandbox to
Production

Tier 2 or higher
sandbox to
Production

Sandbox to
Production

Five hours Four hours

Other Production Maintenance mode Five hours Not applicable,
because the
customer indicates in
the service request
when the
environment should
be taken out of
maintenance mode
again

Production IP safe list rules Five hours Two hours

Production Power BI Embedded Five hours Two hours
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The survey will take about seven minutes. No personal data is collected (privacy statement).
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Do I have to move Azure AD tenants when I move from a CSP
agreement to a Volume Licensing agreement?

Do I get a new LCS Implementation project when I move from a CSP
agreement to a Volume Licensing agreement?

Can I keep the existing LCS Implementation project when I move to
different Azure AD tenant?

How long does it take to move from a CSP agreement to a Volume
Licensing agreement?

What if I forget to delete the existing environments before I suspend
the existing subscription?

When customers subscribe through a Microsoft Volume Licensing agreement or a Microsoft Cloud Solution

Provider (CSP) agreement, they usually have one Microsoft Azure Active Directory (Azure AD) tenant, one

Microsoft Dynamics Lifecycle Services (LCS) Implementation project and any number of sandbox environments

that are deployed to one data center of the customer's choice, and one production environment. For more

information about these core concepts, see Finance and Operations application architecture. Although this setup

works well for most projects, more advanced scenarios are sometimes required, or changes during the

implementation lifecycle must be accommodated.

This topic provides answers to frequently asked questions about subscriptions and licenses, Azure AD tenants,

and LCS Implementation projects.

For more information, see the following topics:

Move environments between data centers

Move licenses between agreement types

Move LCS implementation projects to different Azure AD tenants

Multiple LCS projects and production environments on one Azure AD tenant

No. You can keep the existing Azure AD tenant, but you must make sure that the Volume Licensing subscriptions

are purchased against the same Azure AD tenant as the CSP subscriptions.

No. The LCS project remains the same.

No. A new LCS project will be created.

For a Volume Licensing purchase, it can take a few days for the order to be processed and the subscriptions to

be activated. Redeployment of add-on environments has a service level agreement (SLA) of two business days.

It takes a few hours to deallocate and delete old add-on environments.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/subscription-overview.md


Can I have a CSP agreement and a Volume Licensing agreement in
parallel?

How can I find the Tenant name and Tenant ID within LCS?

How can I find the subscription status?

How would the subscription status impact the environment?

NOTENOTE

If you don't deallocate and delete the existing environments before you suspend the subscriptions, the

environments will remain in a DeployedDeployed state. However, if you try to access the full details of these

environments, you will receive an error message.

Yes. However, you must maintain the minimum required number of licenses under each program.

1. Go to project home page in LCS.

2. In the EnvironmentsEnvironments  section, select Subscr iptions availableSubscr iptions available.

3. On the Subscr iptions availableSubscr iptions available page, you will find the Tenant nameTenant name and the Tenant IDTenant ID.

1. Go to the project home page in LCS.

2. In the EnvironmentsEnvironments  section, select Subscr iptions availableSubscr iptions available.

3. On the Subscr iptions availableSubscr iptions available page, you’ll find all Ser vice plansSer vice plans  available to the tenant.

4. The Assigned dateAssigned date indicates the date that service plan status was changed.

Some of the environment's operations may be impacted by the subscription status:

ActiveActive - Your subscription is in an operative state. You should be able to perform all environment operations.

In Grace PeriodIn Grace Period - Your subscription has expired, but is within the grace period. You should renew your

subscription soon. The subscription status won’t impact your license quantity, ability to deploy a new

environment, or to perform environment operations.

SuspendedSuspended - Your subscription has expired beyond the grace period. This subscription status may reduce

the license quantity, impact your ability to deploy a new environment, or impact your ability to perform

environment operations.

DeletedDeleted - Your subscription has been deleted. This will impact your ability to deploy a new environment or

perform environment operations.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Move sandbox environments

Save dataSave data

Move the environmentsMove the environments

Occasionally, you must move environments that are managed by Microsoft to a different Microsoft Azure data

center. Here are some scenarios where this move might be required:

The data center that you planned to use wasn't available when the environments were originally deployed.

The project creators didn't do enough research to determine the best data center before the environments

were originally deployed.

The customer moves the physical location of its operations, and the wide area network (WAN) connection is

now closer to a data center that provides lower latency.

Microsoft asks that you keep all your environments in the same data center. When you move environments to a

different data center, you should plan to eventually have all environments deployed in the same data center.

You can verify the data center that an environment is deployed to on the Manage environmentsManage environments  page in

Microsoft Dynamics Lifecycle Services (LCS).

To change the data center, you must redeploy all environments. The process differs for sandbox environments

(sandbox standard acceptance test environments, and sandbox develop and test environments) and production

environments.

Because this move is a self-service action, the partner and/or customer must move the existing sandbox

environments without Microsoft involvement. Although this action requires little effort on the part of the

partner or customer resources, completion of the end-to-end process might require a few days. To streamline

the data movement between environments, you should develop a plan to determine the best sequence before

you begin the move.

Before you begin the move, you must save your data.

Tier  1 environment database that is based on Microsoft SQL Ser ver :Tier  1 environment database that is based on Microsoft SQL Ser ver : Make a backup of the

database.

Tier  2 and higher environments that are based on Azure SQL Database:Tier  2 and higher environments that are based on Azure SQL Database: Choose one of the

following options:

Option 1:Option 1: Review the processes that are listed in the Database movement operations home page

topic.

Option 2:Option 2: If you have an Azure subscription, save a copy of the Azure SQL database under that

subscription.

Option 3:Option 3: If you have multiple Azure SQL database environments, redeploy one environment, leave

the remaining environments in the old data center, and then request a database refresh between the

environments.

Option 4:Option 4: Save data as data packages, and then import the packages after the redeployment is

completed.

After you've saved your data, follow these steps.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/move-environments-data-center.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/database/dbmovement-operations


NOTENOTE

Move production environments

NOTENOTE

1. Verify that all code packages have been uploaded to the Asset library in LCS.

2. For each environment, follow these steps:

a. In LCS, select Full detailsFull details .

b. Stop the environment, and then, when the environment has stopped, select DeallocateDeallocate.

c. After the deallocation is completed, select DeleteDelete.

d. After the environment is deleted, select ConfigureConfigure to redeploy the environment.

e. In the Geography/locationGeography/location field, select the data center to use.

f. After the environment is deployed, apply the code packages.

g. If the redeployed environment is used as the build environment, complete the required configurations

that are described in Deploy and use an environment that supports continuous build and test

automation.

h. Restore the data.

The movement of files that are stored in Azure Blob Storage isn't supported in sandbox environments.

Commerce customers should be aware that extra steps are required for components to work correctly after a move.

For more information, see Data management overview.

If you already have a production environment deployed, you must open a Support request to move the

production environment to another data center after you've finished moving all the sandbox environments. This

scenario is rare, and there is no automated/self-service action to complete the move. In this scenario, files that

are stored in Azure Blob Storage will also be moved. For information about the maintenance window and

downtime that are required in order to move a production environment to a different data center, see Service

Description and the related service-level agreement (SLA) documents.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/perf-test/continuous-build-test-automation
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/data-entities-data-packages
https://go.microsoft.com/fwlink/?LinkId=867755&clcid=0x409
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

The customer has only default environments

Sometimes, a customer who originally purchased subscriptions through a Microsoft Cloud Service Provider

(CSP) agreement decides to change to a Microsoft Volume Licensing agreement with Microsoft after the

Microsoft Dynamics Lifecycle Services (LCS) Implementation project has been created. The customer can make

this change even after the project has gone live in production.

Less often, a customer who originally purchased the subscriptions through a Volume Licensing agreement with

Microsoft decides to change to a CSP agreement. In this case, the change must align with the renewal date of the

Volume Licensing agreement.

The process of moving subscriptions from one type of agreement to another is primarily a commercial process.

The technical implications for the LCS Implementation project are minimal.

The movement of subscriptions between agreement types isn't the same as the movement of an Azure Active Directory

(Azure AD) tenant. If the contractual changes in the agreements require that an Azure AD tenant be moved, you must

also follow the process that is described in Move LCS implementation projects to different Azure AD tenants.

Subscriptions come with two standard environments: a production environment and a Tier-2 Standard

Acceptance Test environment. These environments aren't affected by the movement of subscriptions between

agreement types. Action might be required in LCS only if the customer has additional add-on environments. In

this case, action that is related to the add-on environments requires minimal effort on the part of partner or

customer resources. To streamline the movement of data between environments, you should plan in advance to

determine the best sequence.

If the customer has only the two standard environments that come with the Microsoft-managed subscription,

and didn't purchase any add-on environments through the original CSP agreement or Volume Licensing

agreement, the activities that are required are purely commercial.

IMPORTANTIMPORTANT

1. The customer places the order for subscriptions under the new agreement with the Volume Licensing

reseller or the CSP.

Make sure that the subscriptions are purchased against the same Azure AD tenant that is used on the original

agreement.

2. The customer activates the subscriptions.

3. In Microsoft 365 Admin center, the customer verifies that both the new and subscriptions and the existing

subscriptions are active.

4. When the new subscriptions are active, the customer requests that the Volume Licensing reseller or the

CSP suspend the existing subscriptions. Typically, there is an overlap to help guarantee continuity and

avoid disruption of service.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/move-licenses-between-agreement-types.md


The customer has add-on environments

PrerequisitesPrerequisites

Commercial activitiesCommercial activities

Deploy new environmentsDeploy new environments

Delete environments under the obsolete agreementDelete environments under the obsolete agreement

Update environmentsUpdate environments

NOTENOTE

If the customer purchased add-on environments through the original CSP agreement or Volume Licensing

agreement, those environments should be redeployed.

Before you begin the move, you must complete the following tasks:

Save the data from your existing environments. Follow one of the options described in Database

movement operations home page.

Verify that all code packages have been uploaded to the Shared asset library in LCS.

IMPORTANTIMPORTANT

1. The customer places the order for the subscriptions under the new agreement with the Volume Licensing

reseller or the CSP. These subscriptions include the subscriptions for the add-on environments.

Make sure that the subscriptions are purchased against the existing Azure AD tenant.

2. The customer activates the subscriptions.

3. In Microsoft 365 Admin center, the customer verifies that both the new subscriptions and the existing

subscriptions are active.

1. When the new subscriptions are active, additional add-on environments that you can configure appear in

LCS. Deploy the add-on environments, and configure them as appropriate.

2. Apply the deployable packages, and restore the data.

Follow these steps for every environment that was deployed under the old agreement. After you've deleted the

environments, don't use or redeploy them again.

1. In LCS, on the Environment detailsEnvironment details  page, select Full detailsFull details .

2. Stop the environment, and when the environment has stopped, select DeallocateDeallocate.

3. When the deallocation is completed, select DeleteDelete.

4. When the environment has been deleted, select ConfigureConfigure.

1. The Volume Licensing reseller or the CSP suspends the existing subscriptions.

2. Any original add-on environments no longer appear in LCS.

Until physical redeployment of the add-on environments is completed, both existing subscriptions and new subscriptions

must be kept in an active state.

The movement of files that are stored in Azure Blob storage isn't supported in sandbox environments.

Commerce customers should be aware that extra steps are required in order for components to work

correctly after the move. For more information, see Data management overview.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/database/dbmovement-operations
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/data-entities-data-packages
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Activate subscriptions on the new tenant

Cloud service providerCloud service provider

Volume LicensingVolume Licensing

You can move your subscriptions and your Microsoft Dynamics Lifecycle Services (LCS) Implementation project

to a different Microsoft Azure Active Directory (Azure AD) tenant. Here are some scenarios where this move

might be required:

NOTENOTE

Subscriptions were accidentally purchased against the incorrect Azure AD tenant.

If you're a cloud service provider, and you sell subscriptions for Finance and Operations apps to an existing

customer, you must request a reseller relationship with that customer to put the subscriptions on the customer's

existing Azure AD tenant. If you create a new customer record for the customer in Microsoft Partner Center, you

create a new Azure AD tenant for the customer.

The customer changes the structure of the Azure AD tenant after the subscription is purchased.

The process for moving your subscriptions and all related artifacts has four main steps, as shown in the

following illustration.

Work with your cloud service provider or volume license reseller to activate the subscriptions against the new

Azure AD tenant. All subscriptions for users, and for add-on environments, must be activated.

If you're licensed through a Microsoft Cloud Solution Provider (CSP) agreement, purchase the required

subscriptions against the new tenant from your cloud service provider. If the new tenant already exists, the cloud

service provider must request a reseller relationship. Alternatively, in Partner Center, the cloud service provider

must create a new customer that has the desired default domain name, * .onmicrosoft.com*.onmicrosoft.com (for example,

contoso.onmicrosoft.comcontoso.onmicrosoft.com).

Ask the cloud service provider not to suspend the existing subscriptions at this time.

If you're licensed through a Microsoft Volume Licensing agreement, you must call the Volume Licensing support

center and ask that the subscriptions be remapped from the old tenant to the new tenant. You can contact

Volume Licensing Support through Microsoft 365 Admin center. Request a grace period, when the subscriptions

will be active on both tenants. Because of customer privacy concerns, this request must be made by the

customer. You should have the following information available:

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/move-lcs-implementation-project-tenant.md
https://www.microsoft.com/Licensing/servicecenter/Help/Contact.aspx


IMPORTANTIMPORTANT

Configure LCS on the new tenant

IMPORTANTIMPORTANT

Move your sandbox environments to the new tenant

Public customer number.

Enrollment number.

The current tenant domain that the subscriptions are currently provisioned on.

The destination tenant domain that the customer wants the subscriptions provisioned under.

A detailed explanation of why the customer must have its Volume Licensing subscriptions migrated to a

different tenant.

The total number of paid subscriptions that must be moved to the new tenant, together with the subscription

type and seat count.

It's crucial that the subscriptions be active on both tenants in parallel for a few weeks, until you've finished

decommissioning LCS on the old tenant.

On the new tenant, you will get a new LCS project that you must initiate and set up.

1. Complete the Project Onboarding wizard. For more information, see LCS project onboarding. When

completing the wizard, you must indicate on the Project Over viewProject Over view  page that you are Moving existingMoving existing

LCS project from another tenantLCS project from another tenant and provide the source LCS project ID.

2. Fully configure LCS. As part of this configuration, you must:

a. Upload and activate a subscription estimator. If you are already live in the source LCS project, you

need to ensure that the estimates match.

b. Add your deployable package to the asset library.

c. Update your Business process modeler (BPM) library.

During this period, you will have two parallel LCS projects. You can verify the name and ID of the Azure AD tenant that is

associated with an LCS project on the Subscriptions availableSubscriptions available page in LCS.

1. Deploy the non-production environments in the new LCS project.

2. Apply the required code packages to the environments. Make sure that the target is running the same

application version as the source. We recommend using All-in-one deployable packages and include any

ISV licenses, if applicable.

3. Upload data to the environments. You can move the data through data packages or by restoring the

database. If you restore the database, additional steps are required in order to remap some properties to

the new tenant.

4. Update your user information.

a. Remove all user accounts except the admin user.

b. Fix the admin user record in USERINFO.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/project-onboarding
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-tools/aio-deployable-packages


IMPORTANTIMPORTANT

Move your production environment to the new tenant

    UPDATE USERINFO
    SET SID='mysid', NETWORKALIAS='myalias/email', NETWORKDOMAIN='https://sts.windows.net'
    WHERE ID = 'Admin'
    ```

 Update POWERBICONFIG set TENANTID = 'newtenantid' where TENANTID = 'oldtenantid'
 Update PROVISIONINGMESSAGETABLE set TENANTID = 'newtenantid' where TENANTID = 'oldtenantid'
 Update B2BINVITATIONCONFIG set TENANTID = 'newtenantid' where TENANTID = 'oldtenantid'
 Update RETAILSHAREDPARAMETERS set TENANTID = 'newtenantid' where TENANTID = 'oldtenantid'

5. Re-import all other users that have the correct security identifier (SID) and identity provider.

6. Run the following commands to update the tenant ID in the appropriate tables. You can verify the Azure

AD tenant ID that is associated with an LCS project on the Subscr iptions availableSubscr iptions available page in LCS.

7. Fully configure the environments. As part of this step, configure the integration endpoints.

8. Perform smoke tests on the user acceptance testing (UAT) environment in the new LCS project. These

tests should focus on user sign-in, integrations, workflows, printing, reporting, and similar processes that

depend on configuration and user information.

Depending on your solution and scope, you might have to perform additional steps on the new Azure AD

tenant. These steps might include registering applications (for recurring integrations and warehouse

management), adding domains, and setting up directory synchronization to enable single sign-on (SSO).

Note that calls to web services are allowed only from the homehome tenant for the environment. For example, the

original tenant was companya.com, and integration ran as services\@companya.com . In this case, when you

switch tenants to companyb.com, you can no longer use services\@companya.com  for web service calls, even if

you update userInfo.networkdomainuserInfo.networkdomain to https://sts.windows.net/companyb.com .

On your sandbox environments, you will lose any document handling attachments that are stored in Azure Blob storage.

Blob storage will be moved by Microsoft only for production environments.

If you do not have a production environment deployed already on the old tenant, you can skip this section.

If you already had a production environment deployed on the old tenant, Microsoft will move your database and

Azure Blob storage from your old production environment to the new one. As a pre-requisite, you must

complete the additional steps below after you've finished moving all the sandbox environments and completed

UAT. The process of moving a production environment to a new tenant requires a downtime.

Before requesting the production environment, ensure that all pre-requisites are completed:

1. Get all required licenses that are needed to correctly license all users on the production environment.

2. When the licenses are in place, upload a subscription estimator to the new LCS project. It should match

the subscription estimator that is active in the source LCS project, and it must correctly reflect peak

transaction volumes.

3. Send an email to Dynamics 365 FO Go-Live (d365fogl@microsoft.com) stating that your new LCS project

is ready for Microsoft to move your production database and Azure Blob Storage. To ensure that the

process will run smoothly, provide the following details in the email. We suggest that copy the following

list to your email, and then answer all of the information line by line.



Lifecycle Ser vicesLifecycle Ser vices

Provide the LCS IDs (number in the LCS project URL) for source and target LCS project.

Confirm that the go-live date is set correctly in the target LCS project.

Confirm that the update schedules are set in the target LCS project (LCS > Menu > Project settingsLCS > Menu > Project settings

> Update settings> Update settings ).

Confirm if you are using Azure Blob Storage for document attachments.

Confirm that your project is identified as a tenant move in the Project Onboarding wizard.

TestingTesting

Confirm that the smoke testing is completed on the sandbox environment (Tier-2 or higher) in the

target LCS project.

Code ManagementCode Management

Confirm that your deployable package is marked as a release candidate in the target LCS project.

List the ISV solutions you are using.

Confirm which version your old production environment is running on.

Confirm that non-standard code to be applied in the new production environment will be exactly the

same as the non-standard code present in the old production environment in order to prevent

database copy issues.

Confirm if there were any non-typical actions taken on your old production environment which need

to be considered on the new production environment, like installation of a custom font or

environment upscale.

EnvironmentEnvironment

Share which environment version you plan to deploy your new production environment.

Describe how you will conduct your cut over.

Confirm the dates when the source LCS environments and project will be deallocated and deleted.

4. The Dynamics 365 FO Go-Live team will reply to you within 2 business days and a FastTrack Solution

Architect will work with you on the assessment of the project readiness for production deployment.

5. When the tenant move assessment is successfully completed, the FastTrack Solution Architect will

approve your production request for deployment.

6. Create the production deployment request on the new LCS project.

It is not possible to select the same name for the new production environment, as it is in use for your

old production environment. You will need to choose a new environment name so that a new URL will

be generated.

Make sure you select the same application version that is used by your current production

environment.

In the Production configuration wizard, select a generic user account, not a named user, as

Environment Administrator.

7. After the production environment has been deployed, verify that source and target environments have

exactly the same code, otherwise migration will fail. If necessary, deployable packages must be installed

on the target production environment.

8. Request to copy database and blob storage from the old production environment to the new production

environment.

Cloud deployment to self-ser vice deploymentCloud deployment to self-ser vice deployment: Submit a service request of type OtherOther  to

request that the Microsoft Service Engineering team copy the database and blob storage, if

applicable, from the old production environment to the new production environment. Be sure to

include LCS IDs and environment IDs from source and target projects in the service request.



Tear down the LCS project on the old tenant

Suspend subscriptions on the old tenant

NOTENOTE

Both projects (old and new) are self-ser vice deploymentsBoth projects (old and new) are self-ser vice deployments : Submit a suppor t ticketsuppor t ticket

requesting a copy of the database and blob storage, if applicable, from the old production

environment to the new production environment. Be sure to include LCS IDs and environment IDs

from source and target projects in the support ticket.

a. This process will require interaction between Microsoft and the implementing project team. Ensure

that you follow the email notifications or notifications directly in the service request.

b. After Microsoft has completed the activity and provided you with updated information, you will need

to validate the new production environment.

c. If you encounter an issue after the migration, file a support ticket.

After the new LCS project on the new Azure AD tenant is fully functional, you must stop, deallocate, and delete

the environments on the old LCS project. When you've finished, the ConfigureConfigure button becomes available for

each environment. If you already had a production environment on the old tenant, you must file a support ticket

to have it deleted.

You should save any remaining artifacts from the Asset library that you might require later.

After all environments have been deleted and all artifacts saved, an Organization Administrator on the old

tenant must delete the LCS project. Microsoft reserves the right to disable the customer's account and delete the

customer data after the service has been suspended for an extended period.

After all the environments have been deleted, and you've saved the LCS artifacts that you require, work with

your cloud service provider or Volume Licensing Support to suspend all the licenses on the old Azure AD tenant.

Cloud ser vice providerCloud ser vice provider  - Suspend the existing subscriptions against the old tenant.

Volume Licensing Suppor tVolume Licensing Suppor t - Call Volume Licensing Support to confirm that you've completed the work

and that the subscriptions can now be suspended against the old tenant.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Cloud subscription licenses

Configure LCS cloud implementation project

NOTENOTE

Complete development and testing of updated integrations

Do a trial migration and resolve issues

This topic explains how to move your Microsoft Dynamics 365 Finance + Operations (on-premises)

environments that are hosted on your own infrastructure to the Azure cloud.

If you don't already have cloud subscription licenses, work with your cloud service provider or volume license

reseller to get and activate the required subscriptions on your Azure Active Directory (Azure AD) tenant. All

subscriptions for users and add-on environments must be activated.

If no Finance and Operations cloud-named user subscription licenses have previously been activated on the

Azure AD tenant, a new Microsoft Dynamics Lifecycle Services (LCS) cloud implementation project is

automatically provisioned. Otherwise, you must open a support request to have an LCS cloud implementation

project created. For more information, see Multiple LCS projects and production environments on one Azure AD

tenant.

After your LCS cloud implementation project has been created, you must fully configure it. As part of this

configuration, you must add users, an Azure DevOps association, and subscription estimates, fill in the Asset

library and Business process modeler (BPM), and more.

While you're onboarding your project, you must select AX 2012 UpgradeAX 2012 Upgrade as the source system, so that a singleton

Azure SQL database will be used for your sandbox instead of an elastic pool. Eventually, a more appropriate option will be

available, such as On-premises Finance and OperationsOn-premises Finance and Operations .

You will probably have to make some changes to the integration design patterns that you used for interfaces

with your Finance + Operations (on-premises) environment. These changes can be substantial, and a detailed

discussion of them is beyond the scope of this topic. Nevertheless, you must evaluate all your interfaces and

make the appropriate changes to them.

You should consider developing your updated interfaces in such a way that they can coexist in the same code

base as the original interfaces. This approach will simplify code lifecycle management during the period of your

transition from on-premises to cloud. If this approach isn't possible, you must manage a new development

branch through your cloud go-live. To simplify management of this new branch during the transition period, we

recommend that you freeze other code changes as much as you can. Additionally, in your detailed cut-over plan,

you should carefully document the steps for inactivating your old interfaces and activating the new interfaces.

1. Deploy a tier-2 environment.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/lifecycle-services/move-on-prem-to-cloud.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/implement-multiple-projects-aad-tenant#requesting-multiple-lcs-projects-on-the-same-azure-ad-tenant


SELECT SID,NETWORKALIAS,NETWORKDOMAIN,IDENTITYPROVIDER from USERINFO WHERE ID = 'Admin'
SELECT VALUE from SYSSERVICECONFIGURATIONSETTING where name = 'TENANTID'
SELECT TENANTID from POWERBICONFIG
SELECT TENANTID from PROVISIONINGMESSAGETABLE
SELECT TENANTID from B2BINVITATIONCONFIG
SELECT TENANTID from RETAILSHAREDPARAMETER
SELECT SHAREDFOLDERPATH from DMFPARAMETERS

SqlPackage.exe /a:import /sf:D:\BacpacToImport\my.bacpac /tsn:<Azure SQL database server> /tdn:
<target database name> /tu:<axdbadmin user from LCS> /tp:<axdbadmin password from LCS> 
/p:CommandTimeout=1200

UPDATE USERINFO SET SID='<preserved SID>', NETWORKALIAS='<preserved NETWORKALIAS>', 
NETWORKDOMAIN='<preserved NETWORKDOMAIN>', IDENTITYPROVIDER='<preserved IDENTITYPROVIDER>' WHERE ID = 
'Admin'
UPDATE SYSSERVICECONFIGURATIONSETTING set VALUE='<preserved VALUE>' where name = 'TENANTID'
UPDATE POWERBICONFIG SET TENANTID='<preserved TENANTID>'
UPDATE PROVISIONINGMESSAGETABLE SET TENANTID='<preserved TENANTID>'
UPDATE B2BINVITATIONCONFIG SET TENANTID='<preserved TENANTID>'
UPDATE RETAILSHAREDPARAMETER SET TENANTID='<preserved TENANTID>'
UPDATE DMFPARAMETERS SET SHAREDFOLDERPATH='<preserved SHAREDFOLDERPATH>'
DROP TABLE IF EXISTS SYNCLOG
DROP TABLE IF EXISTS SYNCLOCK
DROP SCHEMA IF EXISTS SF

2. Apply the same code package that is applied in your on-premises production environment (or, as

appropriate, in the current build from the cloud integration development branch that was discussed in

the previous section). This code package should be a single, complete deployable package that includes

any independent software vendor (ISV) solutions and licenses.

3. In SQL Server Management Studio (SSMS), run the following Transact-SQL (T-SQL) commands against

the sandbox database to preserve the current Admin account, Azure AD tenant ID information, and Data

management framework (DMF) shared working directory in that database. Save the results.

4. Copy the database from on-premises to online. The export and import process that you use is the same

process that is described in the Golden configuration promotion database movement tutorial. However, in

this case, the source database is the existing on-premises production SQL database, and you must use the

sqlpackage.exe approach that is described for importing into a developer environment. If you use the LCS

self-service database import option instead, some data won't be imported, as noted in the warnings

about data elements that are cleaned up. The target database information that is available in the LCS

environment details must be used instead of the placeholders that are shown in the following code.

5. Restore the Admin account, Azure AD tenant ID, and DMF shared directory values. Also remove the SFSF

schema and its tables, if they are present.

6. Reimport all other users, and assign the appropriate security roles.

7. Direct printing in a cloud environment is done via the Document Routing Agent (DRA). Set up sandbox

DRAs as described in Install the Document Routing Agent to enable network printing, so that regression

testing can include your printing scenarios.

8. Copy document handling attachments to the cloud. Document handling attachments aren't stored in the

database. If they must be preserved, you must move them separately. For instructions, see the Migrate

document handling attachments to your sandbox section later in this topic.

9. Run a complete regression test cycle. This cycle should include testing of integrations.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/database/dbmovement-scenario-goldenconfig
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/install-document-routing-agent


 

Repeat the migration to production

Migrate document handling attachments to your sandbox

10. Resolve any issues that are discovered during testing. For each issue, document and keep track of the

correcting adjustments that you make in the sandbox, and repeat them in the on-premises source. If any

change must not be made in the on-premises environment, because it's incompatible with the correct

functioning of that environment, we recommend that you create a DMF data package for it instead of

manually applying it for each iteration of the migration process.

11. Repeat steps 2 through 10 until all tests have been passed, and no further changes are being made to

code or the configuration.

1. Deploy the new production environment. Note that the regular prerequisites apply. For example, you must

have an active subscription estimator, complete the LCS methodology phases before the operate phase, and

complete the FastTrack readiness review. For more information, see Prepare for go-live.

2. Apply the final version of the software deployable package to production.

3. Stop making data changes to the on-premises production environment.

4. Repeat steps 3 through 6 in the Do a trial migration and resolve issues section to copy the final/up-to-date

on-premises production database to the cloud sandbox.

5. Repeat step 8 in the Do a trial migration and resolve issues section to copy the final/up-to-date document

handling attachments to the cloud sandbox.

6. Request a database refresh from sandbox to production. (The process is the same as the process that is used

to promote a golden configuration database to production.)

7. Open a support request to have Dynamics Support Engineering copy the document handling attachments

from the sandbox storage account to the production storage account and update the references in the

production database's DocuValue and DocuDeletedValue tables. After the request has been completed,

validate that the attachments are available for a sample of document handling records.

8. Set up DRAs for production. If you're reusing any of the DRAs that were previously installed as part of your

trial migration, remember to update their configuration so that they connect to the production URL instead

of the sandbox URL.

9. Reconcile your cloud and on-premises production environments, as detailed in your cut-over plan.

10. Obtain sign-off for the go-live.

11. Activate cloud production interfaces, batch jobs, and so on.

12. Start to transact in your cloud production environment.

Document handling attachments for Finance + Operations (on-premises) environments are stored in a file

share. However, the cloud version doesn't support this file share. You can use the following procedure to copy

the attachments to the Azure storage account for your sandbox environment and update the corresponding

metadata in the database. For subsequent promotion to production, you can request that Dynamics Support

Engineering copy the attachments from your sandbox to production.

1. Upload a copy of the document handling attachment files from the on-premises production file share to a

temporary folder on one of the sandbox instances of Application Object Server (AOS). For example, you can

upload a zip file of the attachments and unpack it on the target. If you don't have remote desktop access (for

example, for a self-service environment), you can use a different virtual machine (VM) instead. For

reasonable conversion performance, this VM should be in the same Azure datacenter as the target sandbox.

If you aren't using the AOS instance, you must add the VM to an allow list for access to the sandbox's SQL

database instance.

2. Open a support request to get the name of the sandbox Azure storage account and a time-limited shared

access signature token for the documents container. Update the corresponding placeholders in the

Windows PowerShell script that is run in the next step. Also update the placeholders for your temporary

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/imp-lifecycle/prepare-go-live


#Upload F&O on-prem document handling attachments to Azure storage account
#
$filesPath = "<TEMP_ATTACHMENTS_FOLDER_PATH>"
$dBHostName = "<DATABASE_SERVER>.database.windows.net"
$dBName = "<DATABASE_NAME>"
$dBUsername = "<DATABASE_USER>"
$dBPassword  = "<DATABASE_PASSWORD>"
$storageAccountName = "<STORAGE_ACCOUNT_NAME>"
$sasToken = "<SAS_TOKEN>"

[Reflection.Assembly]::LoadWithPartialName("System.Security.Cryptography") #Load crypto
$cryptoObj = [System.Security.Cryptography.SHA256]::Create()
$StorageContext = New-AzStorageContext -StorageAccountName $storageAccountName -SasToken $sasToken
foreach ($file in Get-ChildItem $filesPath) 
{
    try
    {
        $blob = (Set-AzStorageBlobContent -Context $StorageContext -Container documents -File 
$file.FullName -Blob "$($file.Name)" -Force).ICloudBlob
    }
    catch
    {
        Write-Host "Could not upload $($file.Fullname) to blob"
        Write-Host $_
    }
    if($blob)
    {
        #Write-Host "Processing $($file.Fullname)..."
        #FileHash:
        $fileBytes = [System.IO.File]::ReadAllBytes($file.FullName)
        $hashBytes = $cryptoObj.ComputeHash($fileBytes)
        $encodedHash = [System.Convert]::ToBase64String($hashBytes)
        #FullFileName:
        $origFileName = (Invoke-Sqlcmd -Query "SELECT ORIGINALFILENAME FROM DOCUVALUE WHERE FILEID = 
'$($file.Name)'" -ServerInstance $dBHostName -Database $dBName -Username $dBUsername -Password 
$dBPassword).ORIGINALFILENAME
        if ($origFileName.Length -eq 0)
        {
            $origFileName = (Invoke-Sqlcmd -Query "SELECT ORIGINALFILENAME FROM DOCUDELETEDVALUE 
WHERE FILEID = '$($file.Name)'" -ServerInstance $dBHostName -Database $dBName -Username $dBUsername -
Password $dBPassword).ORIGINALFILENAME
        }
        if ($origFileName.Length -eq 0)
        {
            Write-Host "Missing DOCUVALUE $($file.Name)"
        }
        else
        {
            $nameBytes  = [System.Text.Encoding]::UTF8.GetBytes($origFileName)
            $encodedName =  [System.Convert]::ToBase64String($nameBytes)
            #Write-Host "Base64 encoded original filename $encodedName."
            $blob.Metadata["FileHash"] = $encodedHash
            $blob.Metadata["FileSize"] = $file.Length
            $blob.Metadata["FullFileName"] = $encodedName
            $blob.SetMetadata()
            Write-Host "Uploaded $($file.Fullname)"
        }
    }
}

folder, and for your Finance and Operations transactional database, by using the environment details in

LCS.

3. Run the following Windows PowerShell script on the sandbox AOS instance or other VM to upload the

document handling files to the storage account and create the required metadata for each file.
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update DOCUVALUE
set ACCESSINFORMATION = replace(ACCESSINFORMATION, 'file://<SOURCE_PREFIX>/documents/', 
'https://<STORAGE_ACCOUNT>.blob.core.windows.net/documents/'), STORAGEPROVIDERID = 1
where STORAGEPROVIDERID = 4 --4 for LBD filesystem, 1 for Azure blob
and ACCESSINFORMATION like 'file://<SOURCE_PREFIX>/documents/%'

update DOCUDELETEDVALUE
set ACCESSINFORMATION = replace(ACCESSINFORMATION, 'file://<SOURCE_PREFIX>/documents/', 
'https://<STORAGE_ACCOUNT>.blob.core.windows.net/documents/'), STORAGEPROVIDERID = 1
where STORAGEPROVIDERID = 4 --4 for LBD filesystem, 1 for Azure blob
and ACCESSINFORMATION like 'file://<SOURCE_PREFIX>/documents/%'

4. In SSMS, run the following T-SQL commands to update the DocuValue and DocuDeletedValue records so

that they reference the target storage location.

5. Test a sample of the document handling attachments to make sure that they can now be accessed in the

sandbox environment.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Licensing requirements

Disadvantages of multiple LCS projects

For any new cloud project, one Microsoft Dynamics Lifecycle Services (LCS) Implementation project is

instantiated on a Microsoft Azure Active Directory (Azure AD) tenant that provides access to one production

instance. In rare cases, to handle the requirements of a specific implementation, you might require multiple

production instances that run in parallel. By creating multiple LCS projects against the same Azure AD tenant,

you can have multiple production instances. Here are the most common scenarios where multiple production

instances might be required:

A global implementation's requirements for data residency, latency, or data volume can't be met by one

instance.

Different business units in an organization are implementing the product separately as independent

applications.

Manual intervention by the Microsoft Dynamics Service Engineering (DSE) team is required in order to create

additional LCS projects on a shared Azure AD tenant. This approach should be used only if a single-instance

strategy truly isn't feasible. Before additional LCS projects can be created, customers must provide the business

justification and confirm that they understand all the implications of the approach. This process should be

started as early in the implementation lifecycle as possible. Customers who decide to proceed should inform the

FastTrack solution architect who is assigned to their project that they require additional LCS projects. If no

solution architect is assigned to their project, customers should open a support ticket.

Every LCS Implementation project that runs on the same Azure AD tenant must satisfy the minimum licensing

requirements. For example, if there are three LCS Implementation projects on the same Azure AD tenant, a

customer must purchase no less than three times the minimum number of subscription licenses. Currently, the

minimum license requirement is 20 full user licenses. Therefore, to run three LCS Implementation projects on

the same Azure AD tenant, the customer must purchase at least 60 licenses.

Because the licenses are associated with the Azure AD tenant, the Subscr iptions availableSubscr iptions available page for every LCS

project will show the total number of licenses, even though a given LCS project can use only the portion of

licenses that has been allocated to it. This allocation of license to LCS projects must be documented outside the

system.

Users who access multiple environments in parallel must be licensed separately for each environment. A user

can only be assigned one license for each product for each Azure AD tenant. This allocation of licensing

requirements for LCS projects for specific users must be documented outside the system. For additional

information about licensing, download the Licensing guide.

There are some disadvantages to having multiple LCS projects. Here are some of them:

Master data isn't shared.

Intercompany transactions aren't supported.

Integrations must be configured in each LCS project.

Each LCS project requires a separate Bring your own database (BYOD) instance

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/implement-multiple-projects-aad-tenant.md
https://go.microsoft.com/fwlink/?LinkId=866544&clcid=0x409


Advantages of multiple LCS projects

Requesting multiple LCS projects on the same Azure AD tenant

Online deployments in China sovereign cloud

NOTENOTE

User acceptance testing (UAT) must be done on each instance, even if the code is the same. UAT is required

on each instance, because differences can occur across the LCS projects, even if they share a code base. One

source of differences can be the integration setup and BYOD configuration that must be done separately in

each LCS project and therefore must be tested in each LCS project. Additionally, there might be data

variations, different application configurations per region might affect functionality, and different data

centers might support a different set of Azure services.

Microsoft Azure DevOps must be configured in each LCS project. When customizations and code are shared,

it makes sense to use the same Azure DevOps project.

There are also advantages to having multiple LCS projects. Here are some of them:

Data centers can be selected per LCS project to provide the best latency experience.

Data centers can be selected per LCS project to satisfy statutory requirements for data residency.

There is more flexibility to schedule servicing operations, such as code deployments and upgrades.

If your solution requires multiple LCS projects on the same Azure AD tenant, all LCS projects except the original

project must be provisioned on demand by the DSE team. You should inform the DSE team about this

requirement as early as possible, ideally when the project is being onboarded. For more information, see

Onboard an implementation project. To request additional LCS Implementation projects, the customer must

create a support request by using the Support portal in LCS. In this request, the customer must provide the

following information:

The business justification.

The enterprise and project structure. This information includes the following details:

The name of the Implementation project

The breakdown of licenses per LCS project

Confirmation that the customer understands the implications of multiple LCS projects on the same Azure

AD tenant.

If your implementation includes China deployment/rollout, be informed that Dynamics 365 Finance online

deployment became available in Mainland China starting in April 2019. For more information, see Finance and

Operations apps - operated by 21Vianet in China. This deployment is designed to comply with regulatory

requirements in China and the services include a physically separated instance of a cloud service with a different

tenant (Azure Active Directory) that is operated and transacted by 21Vianet.

This is a single organization in multiple clouds with different tenant (Azure Active Directory). The advantages

and disadvantages of multi-Lifecycle Services projects or production environments described above are still

applicable, but the licensing requirement and requesting procedure are different. Work with your Microsoft

Account Executive or your implementation partners for any process assistance.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Local and regional deployments

Localization and regulatory features

Developing localized solutionsDeveloping localized solutions

Regulatory updates and communicationRegulatory updates and communication

Regulatory updatesRegulatory updates

Communication and alertsCommunication and alerts

Dynamics 365 release plansDynamics 365 release plans

Finance and Operations apps what's newFinance and Operations apps what's new

If your government regulations require data to be stored differently or serviced differently than is required for

other countries/regions, there might be country/region requirements you must consider during deployment.

Consider the following resources that might be relevant to you:

Finance and Operations apps operated by 21Vianet in China

Finance and Operations apps include functionality for the country/regions documented in the Product

localization and translation availability guide. This functionality is enabled based on the primary address of the

active legal entity.

This topic includes lists of resources that can help you do the following:

Learn more about developing country/region-specific solutions.

Get country/region specific updates.

Submit and review regulatory alerts.

Learn how to use country/region specific functionality.

The following resources provides guidance and information that can help developers and ISVs who are creating

country/region-specific customizations or are creating a solution for a country that Microsoft does not support.

Separation of localization models

Apply country/region context

Regulatory certification information in feature titles

Classification of localization features

Country Codes - ISO 3166

The following resources provide information about planned and new localization features.

Regulatory updates

Localization portal (Updated weekly)

Issue search in Lifecycle Services (LCS) (Updated daily)

Regulatory watch and communication of regulatory updates

Submit alerts about country/region-specific regulatory features

The Dynamics 365 release plans provide descriptions of new and enhanced capabilities that are planned for

Dynamics 365 business applications and application platforms.

The What's new or changed in Finance and Operations home page lists the features that are included in specific

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/lcs-solutions/country-region.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/deployment/china-local-deployment
https://aka.ms/dynamics_365_international_availability_deck
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lcs-solutions/separate-localization-models
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lcs-solutions/apply-country-context
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lcs-solutions/regulatory-certifications
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lcs-solutions/classify-localization-features
https://www.iso.org/iso-3166-country-codes.html
https://docs.microsoft.com/en-us/dynamics/s-e/
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/issue-search-lcs
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lcs-solutions/regulatory-watch-communication
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lcs-solutions/submit-localization-alerts
https://docs.microsoft.com/en-us/business-applications-release-notes/


Electronic reportingElectronic reporting

Task guidesTask guides

Country/region specific help contentCountry/region specific help content

releases of the Finance and Operations apps.

The Electronic reporting (ER) tool allows you to configure formats for electronic documents in accordance with

the legal requirements of various countries/regions. ER lets you manage these formats during their lifecycle. For

more information, refer to one of the following topics:

Electronic reporting (ER) overview

Manage the Electronic reporting (ER) configuration lifecycle

Create Electronic reporting (ER) configurations

Extend the list of Electronic reporting (ER) functions

Electronic reporting (ER) destinations

Download Electronic reporting configurations from Lifecycle Services

Import Electronic reporting (ER) configurations

Configure Electronic reporting (ER) to pull data into Power BI

Generate electronic documents and update application data by using ER

Task guides are available from the product help pane and they provide a guided walk-through of key business

processes. You can open a task guide to read the steps of a business process or you can play a task guide to walk

through a business process and enter data.

To find task guides, navigate to a page in in the application and click Help. Task guides that use the page are

listed in the help pane. You can also use the help pane to search for task guides by title.

To learn more, see Help system.
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Austria September 2020 10.0.15 VAT declaration format U30
has been updated for 2020
reporting

Belgium December 2020 10.0.16 Belgium: “Export ledger
transactions” report
performance improvement
in Dynamics 365 Finance

Brazil November 2020 10.0.15HF SPED Fiscal ICMS/IPI -
Record C176 - RS state

Brazil October 2020 10.0.16, 10.0.15HF NF-e NT2019.001 v1.51 -
Adoption of the validation
rules upon Benefit code by
Distrito Federal

Brazil October 2020, November
2020

10.0.16, 10.0.15HF SPED Fiscal - Layout 015

This topic lists the regulatory updates that are planned and released in Dynamics 365 Finance supported

localizations. Delivery timelines might change, and projected functionality might be different or might not be

released. For more information, see Microsoft policy.

Regulatory updates are features that are implemented to support new or changed country-specific legislation.

For additional information about planned and released country-specific features, refer to the Dynamics 365 and

Power Platform release plans.

Microsoft strives to implement new regulatory requirements as early as possible. The actual delivery date

depends on the law announcement date, availability of the requirement details from the local authorities, the

availability of the validation tools, and on the size and complexity of the change.

We plan to deliver regulatory updates in One Version service updates that are released in time for customers to

update and be ready for the enforcement date (for transactional regulatory updates), or for the first mandatory

reporting deadline (for regulatory updates related to reporting). Customers and partners can preview the new

regulatory updates in the Preview Early Adoption Program (PEAP).

In case of late announcement dates, late availability of requirement details or validation tools, or exceptionally

large and complex changes, it might not be possible to make a regulatory update available by the General

Availability date of a monthly update. In these cases, the regulatory update will be shipped as hot fixes for

relevant available monthly updates.

Regulatory updates that are released as part of the monthly updated are indicated by release version only.

Regulatory updates that are delivered either as hot fixes or as part of a release preview can be identified

through the abbreviations HF and PEAP, respectively.

For the latest regulatory update plans, refer to the following table.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/localizations/regulatory-updates.md
https://go.microsoft.com/fwlink/p/?linkid=2007332
https://docs.microsoft.com/en-us/business-applications-release-notes/index


Brazil October 2020 10.0.16 DRCST declaration SC - SEF
262/2020

Brazil October 2020 10.0.16 SPED Fiscal ICMS / IPI
record C176

Brazil December 2020 10.0.17, 10.0.16HF,
10.0.15HF

NF-e NT2020.006 -
Identification of the digital
platform intermediary
(Layout and validation rules
updates)

Europe January 2021 10.0.17, 10.0.16HF,
10.0.15HF

Brexit - Northern Ireland
Protocol impact to Intra-
community trade reporting
in EU countries

Germany January 2021 10.0.16HF ELSTER UstVA VAT advance
notification format was
extended with two new
boxes 37,50 for
unrecoverable debts writing
off

Germany January 2021 10.0.17 Changes in ELSTER VAT
advance notification XML
structure (UstVA)

Global January 2021 10.0.16 Enable reverse charge
mechanism for VAT/GST
scheme

India December 2020 10.0.16, HF, 10.0.15HF TCS on Sales of Goods
Section 206 9(1H) change
based on CBDT press
release

Latvia December 2020 10.0.17 Intrastat format is updated
starting from 2021

Mexico December 2020 10.0.17, 10.0.16, 10.0.15 Attribute "Monto" Update

Netherlands October 2020 10.0.16 Intrastat format is updated
starting from 2021

Netherlands December 2020 10.0.167 New version of Dutch
taxonomy NT15

Poland September 2020 10.0.15 Voluntarily split payment
enhancements

Poland November 2020 10.0.16, 10.0.15 JPK-V7M (VDEK) - Sales
document type FP and RO
for Retail transactions
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Poland September 2020 10.0.15 Poland: JPK-V7M (VDEK) -
unlock possibility to run the
report generation by parts

Poland October 2020 10.0.16 JPK-V7M (VDEK) report -
'Voluntarily split payment'
parameter uptake

Poland November 2020 10.0.16, 10.0.15HF Retail - Issue invoice for
retail customer per request

Poland January 2021 10.0.17, 10.0.16HF ,
10.0.15HF

Poland: JPK_KR (SAF
Accounting books)
clarifications, effective from
January 2021

Russia November 2020 10.0.16 VAT declaration format is
updated to version 5.07
starting from the reporting
for Q4 2020

Russia October 2020 10.0.16 Changes in PBU18 for
accounting reporting for
2020

Russia January 2021 10.0.17 A new format of the
property tax declaration
(technical version 5.07
instead of 5.06) for the
2020 reporting

Spain November 2020 10.0.17 SII update validation and
errors v.2.1(bis) from
January 1, 2021

United Kingdom December 2020 10.0.17, 10.0.16, 10.0.15 Company tax registration in
customer invoices (Brexit -
Northern Ireland Protocol)

United Kingdom December 2020 10.0.17, 10.0.16HF.
10.0.15HF

Brexit - Northern Ireland
Protocol impact on
companies trading goods in
both GB and NI locations
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Additional resources

NOTENOTE

Find all planned and released regulatory updates on Lifecycle Service - Issue search (sign in required).

For a list of the localizations that are supported, see the International availability guide.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://lcs.dynamics.com/Logon/Index
https://aka.ms/dynamics_365_international_availability_deck
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Stock transfer orders for India
2/18/2021 • 6 minutes to read • Edit Online

Set up stock transfers
Enable stock transfer functionalityEnable stock transfer functionality

Set up default transfer type and price type for transfer ordersSet up default transfer type and price type for transfer orders

Configure Master planning parametersConfigure Master planning parameters

NOTENOTE

Set up item master parametersSet up item master parameters

You can use transfer orders to process inventory transfers between warehouses. In India, if the shipping and

receiving branches of the organization have different tax registration numbers, the India Goods and Services Tax

(GST) should be calculated and posted for the transfer order. The tax base may be defined as the current cost

price of the item being transferred or a special transfer price. The tax amount should be posted as GST payable

for the transfer shipment and as GST recoverable upon the transfer receipt. An Inter im transitInter im transit account is used

as an offset account for the posting and is nullified when the transfer order is fully received.

The Stock transferStock transfer  functionality that is available for India supports this process.

Enable the following features in the Feature managementFeature management workspace:

(India) Improvements in unit price and cost price handling in Stock transfer orders

(Stock transfer for India) Set up the default transfer type and price type for transfer orders created from

Master planning

Enable uniform tax amount and GST transaction ID for both shipment and receipt transaction of a stock

transfer order

For more information, see Feature management overview.

You also need to configure the India GST functionality to enable GST calculation for stock transfer orders. For

more information, see India Goods and Services Tax (GST) overview.

You can define a default transfer order type and a default price type for transfer orders that are created

manually. On the Inventor y and warehouse management parametersInventor y and warehouse management parameters  page, on the Transfer ordersTransfer orders  tab,

select Stock transferStock transfer  in the Transfer typeTransfer type field to enable the Stock transferStock transfer  functionality for all newly

created transfer orders. In the Pr ice typePrice type field, select a default price type for newly created stock transfer

orders:

Cost pr iceCost pr ice – The cost price, or the on-hand price, of the item will be used for stock transfer orders.

Transfer pr iceTransfer pr ice – The transfer price that is set up for the item will be used for stock transfer orders.

You can define a default transfer order type and a default price type for transfer orders that are created when

confirming planned orders in the Master planningMaster planning module. On the Master planning parametersMaster planning parameters  page, on

the Standard updateStandard update tab, select Transfer typeTransfer type and Pr ice typePrice type in the Firm - TransferFirm - Transfer  group.

These parameters are only available if the "(Stock transfer for India) Set up the default transfer type and price type for

transfer orders created from Master planning" feature is enabled in the Feature managementFeature management  workspace. Otherwise,

default transfer type and price type are defined by corresponding parameters on the Inventor y and warehouseInventor y and warehouse

management parametersmanagement parameters  page.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/localizations/apac-ind-stock-transfer.md
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/apac-ind-gst


Configure transfer pricingConfigure transfer pricing

Configure stock transfer postingConfigure stock transfer posting

NOTENOTE

NOTENOTE

Create and post a stock transfer order

To calculate GST for an item in a stock transfer order, you need to configure certain parameters on the ReleasedReleased

product detailsproduct details  page, such as HSN codesHSN codes  and Tax rate typeTax rate type. For more information, see Assign HSN codes

and SACs to products.

You can configure the prices that will be used when processing stock transfers for an item. To do this, open the

Transfer pr iceTransfer pr ice page from the Released product detailsReleased product details  page.

You must configure the Inter im transitInter im transit account, which is done on the following pages:

In the Inventor y managementInventor y management module, on the PostingPosting page, on the Transfer orderTransfer order  tab, specify the

Inter im transitInter im transit account.

On the Tax setupTax setup page, click SetupSetup, and on the SetupSetup page specify the Inter im transit for stock transferInter im transit for stock transfer

account for all GST components that may be created for GST on stock transfer. For more information, see

Define main accounts.

The accounts that are used to post interim transit amounts should have Interim transitInterim transit  specified in the Posting typePosting type

field on the Posting validationPosting validation tab of the Main accountsMain accounts page.

You must also set up main accounts to post inventory cost for transfer orders to. Specify the following accounts

from the Inventor yInventor y  tab on the PostingPosting page in Inventor y managementInventor y management:

Inventor y issueInventor y issue

Inventor y receiptInventor y receipt

Inter-unit payableInter-unit payable

Inter-unit receivableInter-unit receivable

Inventor y expenditure, lossInventor y expenditure, loss

The Inventor y expenditure, lossInventor y expenditure, loss  account is required to post the scrap amount when receiving a transfer order with

scrap.

NOTENOTE

1. Go to Inventor y managementInventor y management > Outbound ordersOutbound orders  > Transfer orderTransfer order  and create a new transfer

order.

2. In the From warehouseFrom warehouse field, select the supply warehouse that the items are dispatched from.

3. In the To warehouseTo warehouse field, select the receiving warehouse that the items are delivered to.

4. In the Transfer typeTransfer type field, select Stock transferStock transfer  to apply GST to the transfer of items.

If you select Transfer orderTransfer order  in the Transfer typeTransfer type field, the transfer order will be posted based on the standard

transfer order process.

5. In the Pr ice typePrice type field, select a default price type for transfer order lines.

https://docs.microsoft.com/en-us/dynamics365/finance/localizations/apac-ind-gst-hsn-service-accounting-codes
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/apac-ind-gst-map-configuration-tax-types


NOTENOTE

NOTENOTE

NOTENOTE

6. On the Transfer order linesTransfer order lines  tab, create a new line and in the Item numberItem number  field, select the item to

transfer.

7. In the Transfer quantityTransfer quantity  field, enter the quantity of the items to transfer, and in the UnitUnit field, modify

the default unit of measurement, if required.

8. In the Pr ice typePrice type field, select the price type for the transfer order line, from the following options:

Cost pr iceCost pr ice – The cost price, or the on-hand price, of the item is used for the transfer order line.

Transfer pr iceTransfer pr ice – The transfer price that is set up for the item is used for the transfer order line.

If the Price typePrice type is set to Transfer priceTransfer price, the quantity of the items that are defined for the combination of item

and dimension on the Transfer priceTransfer price page is displayed in the Transfer quantityTransfer quantity  field, but it can be modified.

9. In the Unit pr iceUnit pr ice field, enter the cost price or the transfer price for one unit of the item.

10. Select the Tax informationTax information tab to set up taxes for the transfer order and enter details. You can change

the default information that is displayed in the fields.

11. Select ShipShip > Ship transfer orderShip transfer order , and on the ShipmentShipment page, post the transfer order shipment.

12. Select ReceiveReceive > ReceiveReceive, and on the ReceiveReceive page, post the transfer order receipt.

If the "Enable uniform tax amount and GST transaction ID for both shipment and receipt transaction of a stock

transfer order" feature is enabled in the Feature managementFeature management  workspace, it is only possible to receive a

previously posted shipment. You need to select ShipmentShipment  in the UpdateUpdate field when posting a receipt and select

a previously posted shipment in the Shipment voucherShipment voucher  field.

You can also cancel a previously posted stock transfer order shipment if no receipts have been posted for this

order. On the Transfer ordersTransfer orders  page, select Transfer orderTransfer order  > Transfer order histor yTransfer order histor y . On the Transfer orderTransfer order

histor yhistor y  page, select a previously posted shipment. Select CancelCancel , and confirm the cancellation of the shipment.

The shipment will be canceled, and all inventory movements and GST that was posted for the shipment will be

reversed. The "Transfer Order Cancellation" feature in the Feature managementFeature management workspace must be enabled

to cancel transfer order shipments.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Russia overview
2/18/2021 • 2 minutes to read • Edit Online

General ledger

Advance holders

Cash and Bank

VAT

Fixed assets (Russia)

This topic provides information about functionality that supports Russian regulations.

Correspondence of accounts

Preview ledger transactions

Set up exchange rates for currency transactions

Import currency exchange rates

Ledger translation

Turnover balance statement reports

Account activity reports

Russia advance holders overview

Create an advance holder

Daily operations for advance holders

Advance reports with budget control

Revaluate foreign currency for advance holders

Advance holder reports

Set up bank accounts

Set up and process payment orders

Exchange adjustment

Foreign currency sales, purchases, and transfers

Petty cash

Cash - Local primary forms and unified reports

Local specific posting of sales VAT

Invoice factures processing and printing

Revision factures and corrective factures

Value-added tax (VAT) for tax agents

VAT declaration

Sales books, purchase books, and invoice-factures journals

Prepayments management

Incoming VAT restoring

Process invoice factures for export trade

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/localizations/russia.md
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-correspondence-accounts
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-ledger-transactions-preview
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-exchange-difference
https://docs.microsoft.com/en-us/dynamics365/finance/general-ledger/import-currency-exchange-rates
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-ledger-translation-procedure
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-turnover-balance-statement-reports
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-account-activity-reports
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-advance-holders
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/emea-advance-holders
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-advance-holders-daily-operations
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-advance-holders-reports-dailyops
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-advance-adjustment-parameters
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-local-management-reports-primary-forms
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-local-settings-requisites-bank-module
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-payment-order-settings-processing
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-exchange-adjustment
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-currency-sale-purchase
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/emea-petty-cash
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-local-primary-forms-and-unified-reports
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-local-specific-posting-sales-vat
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-invoice-facture-process-print
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-revise-invoice-facture
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-tax-agent
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-vat-declaration
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-sales-books-purchase-books
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-prepayments-management
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-incoming-vat-restoring
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-export-trade


Set up Fixed assetsSet up Fixed assets

Working with fixed assetsWorking with fixed assets

Not valuable fixed assets, and working clothesNot valuable fixed assets, and working clothes

Printing formsPrinting forms

Accounts payable and receivable

Inventory

Fixed assets overview

Set up fixed assets

Set up depreciation

Depreciation methods

Depreciation bonuses

Set up fixed asset locations and numbering

Create fixed assets (Russia)

Register fixed assets acquisitions

Acquiring fixed assets and putting them into operation

Calculate depreciation

Partial fixed asset disassembly (liquidation)

Sell, dispose, and write-off assets

Create fixed asset lease and return from lease

Maintain fixed assets

Fixed asset counting

Fixed asset currency revaluation

Revaluate fixed asset cost and depreciation

Create and post budget journals for fixed asset acquisitions

Transfer fixed assets

Not valuable fixed assets

Working clothes/special rigging

Printing forms for fixed assets

Credit note corrections

Invoices for payment

Set up dimension control for settlements

Register goods shipped to customers

Cash flow management

Allocation of miscellaneous charges in proportion to weight and volume

Third party miscellaneous charges

Agreements

Transactions through intermediary

Set up and create agreements

Register transactions with reference to agreements

Inquiries and reports with agreements

Purchases on commission

Sales on commission

https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-fixed-assets-overview
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-set-up-fixed-assets
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-depreciation-setup
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-depreciation-methods
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-bonus-depreciation
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-fixed-assets-locations-numbering
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-fixed-assets
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-register-acquisition
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-fixed-asset-acquisition
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-depreciation-calculation
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-fixed-assets-disassembly
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-sell-dispose-write-off-fixed-assets
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-fixed-asset-leasing
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-maintain-fixed-assets
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-fixed-assets-counting
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-fixed-asset-currency-revaluation
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-fixed-assets-revaluation
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-post-budget-fixed-asset-acquisition
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-fixed-asset-transfer
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-not-valuable-assets
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-working-clothes-instruments-accounting
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/printing-forms-fixed-assets
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-credit-note-correction
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-invoice-payment
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-transactions-settlement-date
https://docs.microsoft.com/en-us/dynamics365/supply-chain/localizations/rus-goods-transit-postponed
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-cash-flow
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-miscellaneous-charges
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-third-party-misc-charges
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-agreements
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-set-up-and-create-agreements
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-register-transactions-with-reference-to-agreements
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-inquiries-reports-agreements
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-transactions-through-intermediary
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-purchases-on-commission
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-sales-on-commission


Reporting

Organization administration

Deferrals

Tax accounting

Additional resources

Goods in transit from vendor

Customs declaration numbers

Inventory cost structure

Inventory adjustment wizard

Inventory reports

Inventory profile

Set up an inventory profile

Use an inventory profile in documents and queries

Financial reporting

Configure financial reports in Excel

Accounting reporting in electronic format

Assessed tax declaration

Transport tax declaration

Land tax declaration

Profit tax declaration

Registration IDs

Set up officials

Company divisions

Russian address formats and import from FIAS

Set up deferrals

Create or generate referrals

Receipt of deferrals

Write off deferrals

Dispose of deferrals

Deferrals counting

Reporting for deferrals

Expense and income codes

Assets tax registers

Deferrals tax register

Cash flow tax registers

Electronic reporting overview

Download Electronic reporting configurations from Lifecycle Services

Microsoft Dynamics Localization Portal: Russia report (requires CustomerSource account)

https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-custom-declaration-number
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-inventory-cost-structure
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-inventory-adjustment-wizard
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-inventory-reports
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-inventory-profile-overview
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-set-up-inventory-profile
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-use-inventory-profile-documents-queries
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-financial-reports
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-excel-financial-report
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-accounting-reporting
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-assessed-tax-declaration
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-transport-tax-declaration
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-land-tax-declaration
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-profit-tax-declaration
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/emea-registration-ids
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-officials
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-company-divisions
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-russian-address-format-and-import-from-fias
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-set-up-deferrals
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-create-generate-deferrals
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-deferral-transactions
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-write-off-deferral
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-dispose-deferrals
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https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-reporting-deferrals
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https://docs.microsoft.com/en-us/dynamics365/finance/localizations/rus-cash-flow-tax-registers
file:///T:/eiye/ac1a/dynamics365/dev-itpro/analytics/general-electronic-reporting.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/analytics/download-electronic-reporting-configuration-lcs.html
https://mbs.microsoft.com/files/customer/AX/Support/supportnews/RussianFederation.html


NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Goods in transit from vendor (Russia)
2/18/2021 • 6 minutes to read • Edit Online

Set up an inventory profile for a transferable item

NOTENOTE

Set up a number sequence for the Counting act (INV-6) report

The item counting process (INV-6) is used to identify the quantity and value of inventory items that are in transit

when inventory is counted.

The item counting process is done in the context of nomenclatures, shipping documents, and vendors.

To reflect the goods and materials that are in transit, you can set the kind of inventory for the BasicBasic kind of

activity. The Kind of inventor yKind of inventor y  field can have the following values:

Common

Purchased items in route

1. Go to Inventor y managementInventor y management > SetupSetup > DimensionsDimensions  > Inventor y profilesInventor y profiles .

2. Select NewNew  to create an inventory profile for an item.

3. In the Inventor y profileInventor y profile field, enter the name of the inventory profile.

4. In the NameName field, enter a description of the inventory profile.

5. On the SetupSetup FastTab, in the Kind of activityKind of activity  field, select BasicBasic.

6. Set the Don't match optionDon't match option to YesYes  to prevent on-hand inventory that uses this inventory profile from

being automatically matched with a compatible inventory profile.

7. In the Kind of inventor yKind of inventor y  field, select Purchased items in routePurchased items in route. The Initialize dimensionInitialize dimension and ControlControl

dimension in purchase orderdimension in purchase order  options are automatically set to YesYes .

The Kind of inventor yKind of inventor y  field is available only if you select BasicBasic in the Kind of activityKind of activity  field.

8. On the Matching pr ior ityMatching pr ior ity  FastTab, select UpUp or DownDown to change the order of the inventory profile.

9. Select SaveSave, and close the page.

1. Go to Inventor y managementInventor y management > SetupSetup > Inventor y and warehouse management parametersInventor y and warehouse management parameters .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/localizations/rus-goods-transit-vendor.md


Set up an inventory journal name for the Counting act (INV-6) report

NOTENOTE

Add officials to the Counting act (INV-6) report

NOTENOTE

2. On the Number sequencesNumber sequences  tab, in the Number sequence codeNumber sequence code field, select a number sequence for the

Counting act (INV-6)Counting act (INV-6)  reference.

3. Select SaveSave, and close the page.

1. Go to Inventor y managementInventor y management > SetupSetup > Journal namesJournal names  > Inventor yInventor y .

2. Create a journal name.

3. In the NameName field, enter the inventory journal name.

4. In the Descr iptionDescr iption field, enter a description.

5. In the Journal typeJournal type field, select CountingCounting.

6. On the Repor tsRepor ts  FastTab, in the AvailableAvailable field, select Counting act (INV-6)Counting act (INV-6) , and then select the left arrow

button to move the report to the SelectedSelected field.

If the AvailableAvailable field is blank, select UpdateUpdate on the Action Pane to update the list of available reports.

7. Select SaveSave, and close the page.

You can specify the company officials who are involved in the item counting process for the Counting actCounting act

(INV-6)(INV-6)  report.

1. Go to Organization administrationOrganization administration > SetupSetup > ContactsContacts  > OfficialsOfficials .

2. On the Inventor yInventor y  tab, select the Counting act (INV-6)Counting act (INV-6)  option.

3. Select NewNew  to create an official for the Counting act (INV-6)Counting act (INV-6)  report.

4. In the PositionPosition field, select the designation of the official.

5. In the NameName field, enter the name of the official.

6. In the Job titleJob title field, select the job title of the official.

By default, the job title is copied from the selected employee's record.



Create an inventory tracking dimension group for the Counting act (INV-6) reportCreate an inventory tracking dimension group for the Counting act (INV-6) report

NOTENOTE

Create a purchase agreement

7. Select SaveSave, and close the page.

1. Go to Product information managementProduct information management > SetupSetup > Dimension and var iant groupsDimension and var iant groups  > TrackingTracking

dimension groupsdimension groups .

2. Select NewNew  to create a dimension group.

3. In the NameName field, enter the name of the dimension group.

4. In the Descr iptionDescr iption field, enter a description.

5. On the Tracking dimensionsTracking dimensions  FastTab, on the Inventor y profileInventor y profile line, select the ActiveActive, Pr imar y stockingPrimar y stocking,

Physical inventor yPhysical inventor y , Financial inventor yFinancial inventor y , Coverage plan by dimensionCoverage plan by dimension, and TransferTransfer  check boxes.

6. On the OwnerOwner  line, select the ActiveActive, Physical inventor yPhysical inventor y , Financial inventor yFinancial inventor y , and TransferTransfer  check

boxes.

To make the report reflect the details of shipping and payment documents, on the Batch numberBatch number  line, select the ActiveActive

and Physical inventor yPhysical inventor y  check boxes.

7. Select SaveSave.

1. Go to Accounts payableAccounts payable > Purchase ordersPurchase orders  > Purchase agreementsPurchase agreements .



Add an inventory owner to the Counting act (INV-6) report

2. Select NewNew  to open the Create purchase agreementCreate purchase agreement dialog box.

3. On the VendorVendor  FastTab, in the Vendor accountVendor account field, select the vendor account.

4. In the Purchase agreement classificationPurchase agreement classification field, select Blanket purchase agreementBlanket purchase agreement.

5. On the GeneralGeneral  FastTab, in the DocumentDocument section, in the Purchase agreementPurchase agreement field, enter the ID of the

purchase agreement.

6. Specify other details, and then select OKOK.

7. On the Purchase agreementsPurchase agreements  page, switch to the HeaderHeader  view, and then, on the FinancialFinancial  FastTab, in the

Inventor y profileInventor y profile section, set the following fields:

In the Kind of activityKind of activity  field, select BasicBasic.

In the Inventor y profileInventor y profile field, select the inventory profile that you created earlier.

8. On the Action Pane, on the Purchase agreementPurchase agreement tab, in the GenerateGenerate group, select ConfirmationConfirmation to

update the status of the purchase agreement to EffectiveEffective.

1. Go to Inventor y managementInventor y management > SetupSetup > DimensionsDimensions  > Inventor y ownersInventor y owners .

2. Select NewNew  to add an inventory owner.

3. In the OwnerOwner  field, enter the owner code.

4. In the Account typeAccount type field, select VendorVendor .

5. In the AccountAccount field, select the principal code. The NameName field is filled in automatically.

6. In the Agreement IDAgreement ID field, select the purchase agreement that you created earlier. In this way, you associate

the new owner with the agreement.



Register goods and materials that are in transit

NOTENOTE

7. Select SaveSave.

1. Create a new purchase order. In the Purchase agreementPurchase agreement field, select the purchase agreement that you

created earlier, and then, on the purchase order line, in the Item numberItem number  field, select the item number.

The Tracking dimensionTracking dimension field for the item should be set to the inventory profile that you created earlier.

2. On the L ine detailsL ine details  FastTab, on the ProductProduct tab, in the Tracking dimensionTracking dimension section, validate that the

Inventor y profileInventor y profile field is set to the inventory profile that you created earlier.

3. In the OwnerOwner  field, select the record that you created earlier.



Generate a Counting act (INV-6) report

NOTENOTE

4. Post the invoice in the usual way.

You can use the Pr int of counting act (INV-6)Pr int of counting act (INV-6)  dialog box to generate a Counting act (INV-6)Counting act (INV-6)  report as a

Microsoft Excel file. You must generate this report to track items that are transferred between warehouses and

to create a counting list of the items in the transfer that have been purchased. The counting list can contain on-

hand inventory holdings.

1. Go to Inventor y managementInventor y management > Journal entr iesJournal entr ies  > Item countingItem counting > CountingCounting.

2. Select NewNew  to open the Dimensions displayDimensions display  dialog box.

3. On the Over viewOver view  FastTab, validate that the NameName field is set to the inventory journal name that you created

earlier.

4. In the Store inventor yStore inventor y  section, set the S iteSite and WarehouseWarehouse fields.

5. On the Counting byCounting by  FastTab, validate that the Inventor y profileInventor y profile and OwnerOwner  options are set to YesYes .

You can also set the Batch numberBatch number  and WarehouseWarehouse options to YesYes , if those dimensions are applicable.
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6. Select OKOK to create an inventory counting journal for the items in the transfer.

7. On the CountingCounting page, in the Journal linesJournal lines  FastTab, create a line, and select the item number that you

created earlier.

8. On the L ine detailsL ine details  FastTab, on the Inventor y dimensionsInventor y dimensions  tab, in the Inventor y profileInventor y profile and OwnerOwner

fields, select the records that you created earlier. The On-handOn-hand field on the journal line is automatically

updated.

9. On the Journal linesJournal lines  FastTab, select FunctionsFunctions  > Create counting listCreate counting list to create a counting list. For each

line, the CountedCounted field is updated with the value that is specified in the On-handOn-hand field.

10. On the Action Pane, select Pr intPr int > Counting act (INV-6)Counting act (INV-6)  to open the Pr int of counting act (INV-6)Pr int of counting act (INV-6)

dialog box.

11. In the Date of act completionDate of act completion field, select the date when the counting process is scheduled to be

completed.

12. In the Star t dateStar t date and End dateEnd date fields, select the start and end dates of the inventory counting period.

13. In the Order numberOrder number  field, enter the order number that you're generating the Counting act INV-6Counting act INV-6  report

for.

14. In the Resolution dateResolution date field, select the transaction date of the order that you're generating the CountingCounting

act INV-6act INV-6  report for.

The values in the JournalJournal, Dimension numberDimension number , and Kind of inventor yKind of inventor y  fields are based on the inventory counting

transactions. To change the values of these fields, select FilterFilter . For example, you can modify these values to generate the

report for a different journal or a different dimension.



15. Select OKOK to generate the Counting act (INV-6)Counting act (INV-6)  report.
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Public preview information

Preview availabilityPreview availability

IMPORTANTIMPORTANT

Data processing for the previewData processing for the preview

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

Cloud and edge scale units enable distribution of shop floor and warehouse execution workloads among

different environments. This functionality can help improve performance, prevent service interruptions, and

maximize uptime. It's provided by the following add-ins:

Cloud Scale Unit Add-in for Dynamics 365 Supply Chain Management

Edge Scale Unit Add-in for Dynamics 365 Supply Chain Management

Companies that work with manufacturing and distribution must be able to run key business processes 24/7,

without interruption and at scale. Cloud and edge scale units enable companies to run key mission-critical

manufacturing and warehouse processes without interruption, even when faced with occasional network

connectivity or latency issues.

The preview provides one environment that functions as a cloud-based hub of your Dynamics 365 Supply Chain

Management environment and one environment that functions as a cloud scale unit.

The preview for cloud and edge scale units becomes available for existing customers of Supply Chain

Management in October 2020.

To access the October preview release 10.0.15/Platform update 39 for deployment in your Microsoft Dynamics

Lifecycle Services (LCS) environment, you must be part of the preview early access program (also known as

PEAP) for Supply Chain Management. You can join PEAP if you're already a member of the broader Dynamics

Insider Program. Just select the specific program that is named "Finance & Operations: Preview early access

program (PEAP)."

The scale unit capability for Supply Chain Management is made available only if you agree to the Cloud + Edge Preview

for Finance and Operations terms.

During the public preview, some management services will only be hosted in the United States. However, when

the feature becomes generally available, these management services will be available in all geographies

supported by Supply Chain Management. This affects the transfer and storage of administrative information

used by the scale unit manager, including:

Your tenant names and IDs

Your LCS project IDs

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cloud-edge/cloud-edge-landing-page.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version
https://lcs.dynamics.com/v2
https://experience.dynamics.com/insider
https://aka.ms/SCMCnETerms
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Limitations that apply during the preview periodLimitations that apply during the preview period
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Administrator emails used to sign in

Environment IDs for hub and scale units

Workload configurations

Collected metrics (such as latency and throughput) which are displayed on the map analysis page

Data transferred to and stored in the US data centers will be deleted when your preview environments are shut

down.

To sign up for the cloud and edge preview for Supply Chain Management, your organization must already have

a live Supply Chain Management cloud environment.

The scale unit capabilities are currently in public preview. When you sign up, you must use a user account on the

specific tenant. You must also be a project owner or an environment admin in LCS for an active Dynamics 365

LCS project in that tenant.

When you sign up for the preview, you will select a tenant and go through the sign-up steps. As soon as

Microsoft can allocate preview capacity, we will send you an email that includes the provisioning details and the

promotion (promo) codes for two environments (a hub and a scale unit) for the appropriate LCS project. You will

then be able to deploy the two environments as tier-2 sandbox environments. Those environments will be valid

60 days from the creation date of the promo codes. You should not use the two environments until the step that

is described in the next paragraph is completed.

After you confirm with Microsoft that the two environments have been deployed by using the promo codes, one

of the environments will be configured to work as a hub, and the other will be configured to work as a scale unit.

You can then configure the scale units and deploy selected warehouse management and manufacturing

workloads by using the Scale Unit Manager portal.

Preview environments will automatically be deleted after 60 days. However, they might be deleted sooner if it

appears that they aren't being used. After your preview environments have been deleted, you can sign up and

queue up for a new preview deployment.

To sign up for the preview, go to the Scale Unit Manager portal.

For the initial phase of the preview program for this feature, Microsoft is supporting only hubs that have cloud scale units,

not hubs that have edge scale units. Edge scale units are installed on-premises and are expected to become available

during an upcoming phase of the program.

Because cloud and edge scale units are a preview feature, services that are related to them are currently

available in limited countries and regions. By enabling cloud and edge scale units, you affirm that you

understand that some data that is related to the configuration and processing of cloud and edge scale units

might be stored in a data center that is located in the United States. By enabling cloud and edge scale units, you

also agree to the Cloud + Edge Preview for Finance and Operations terms. To learn more about cloud and edge

scale units, see the documentation.

Your privacy is important to Microsoft. To learn more, read our Privacy Statement.

Some business functionality isn't fully supported in the public preview when workloads are used on scale units. For more

information about the functional workloads, see the sections later in this topic.

https://aka.ms/SCMSUM
https://aka.ms/SCMSUM
https://aka.ms/SCMCnETerms
https://aka.ms/scmcne
https://aka.ms/privacy


Scale units and dedicated workloads

Dedicated manufacturing execution workload capabilities in a scale unitDedicated manufacturing execution workload capabilities in a scale unit

Scale units extend your central Supply Chain Management hub environment by adding dedicated processing

capacity. Scale units can run in the cloud. Alternatively, they can run on the edge at your local facility premises.

Scale units can temporarily be disconnected from the hub environment. When they are connected, scale units

receive all the information that is required to run the dedicated processing for assigned workloads.

For the public preview, you can configure a hub environment with selected workloads on a cloud scale unit by

using the Scale Unit Manager portal. Preview participants who have access to a Local Business Data (LBD) on-

premises environment can also configure the LBD environment as an edge scale unit.

A workload is a defined set of business functionality that can be factored out and delegated to a scale unit.

Currently, the preview features two types of workloads:

Manufacturing execution

Warehouse management

You can assign one of each type of workload per scale unit.

For manufacturing execution, cloud and edge scale units deliver the following capabilities, even when the edge

units aren't connected to the cloud:

Machine operators and shop floor supervisors can access the operational production plan.

Machine operators can keep the plan up to date by running discrete and process manufacturing jobs.

The shop floor supervisor can adjust the operational plan.

Workers can access time and attendance for clock-in and clock-out on the edge, to ensure correct worker pay



Dedicated warehouse management workload capabilities in a scale unitDedicated warehouse management workload capabilities in a scale unit

Onboard scale units for your Supply Chain Management environment
Deploy the preview for cloud and edge scale unitsDeploy the preview for cloud and edge scale units

Select your LCS project tenant and the detailed preview processSelect your LCS project tenant and the detailed preview process

NOTENOTE

calculation.

For more information, see the manufacturing scale unit workload details.

For warehouse management, cloud and edge scale units deliver the following capabilities, even when edge units

aren't connected to the cloud:

Processing of selected wave methods is enabled for sales orders and demand replenishment.

Warehouse workers can run sales and demand replenishment warehouse work by using the warehouse app.

Warehouse workers can inquire into on-hand inventory by using the warehouse app.

Warehouse workers can create and run inventory movements by using the warehouse app.

Warehouse workers can register purchase orders and do putaway by using the warehouse app.

For more information, see the warehouse scale unit workload details.

The following illustration shows the sign-up and provisioning flow for the public preview for cloud scale units.

In the public preview, the Scale Unit Manager portal shows the list of tenants that your account is part of, and

where you're an owner or environment admin for an LCS project.

If the tenant that you're looking for isn't in this list, go to LCS, and make sure that you're either an environment

admin or a project owner of the LCS project for that tenant. Note that only Azure Active Directory (Azure AD)

accounts from the selected tenant are authorized to complete the sign-up experience.

After you apply changes to LCS, it might take up to 30 minutes for the list of tenants to reflect the changes.

For each tenant, the list shows the sign-up status.

https://aka.ms/SCMSUM
https://lcs.dynamics.com/v2
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Select the Click here to sign upClick here to sign up link to sign up your LCS tenant to participate in the preview. You must accept

the terms. You must also supply a business email address where Microsoft can send communications that are

related the preview sign-up process.

Microsoft will review your request and inform you about the next steps by sending an email to the address that

you supplied on the sign-up form.

After you've been granted access to the preview program, you will receive two promo codes for your LCS

project. You can now use those promo codes to deploy two environments in LCS. The environments must use

PEAP release 10.0.15 or later. When you've finished applying the promo codes, notify Microsoft (as instructed),

so that we can finish enabling the environments for the preview features. Microsoft will let you know when this

configuration step is completed.

You can now start to configure scale units and workloads in your preview environment.

When you configure cloud scale units, you can do all the required steps in the Scale Unit Manager portal.



  Manage cloud scale units and workloads by using the Scale Unit Manager portalManage cloud scale units and workloads by using the Scale Unit Manager portal
Go to the Scale Unit Manager portal, and sign in by using your tenant account. On the Configure scale unitsConfigure scale units

page, you can add a hub environment if it isn't already listed. You can then select the hub that you want to

configure with scale units and workloads.

To add one or more scale units that are available in your topology, select Add scale unitsAdd scale units . In the preview, you

should see the cloud scale unit that you deployed from one of the promo codes that you received as part of the

preview program.

On the Defined workloadsDefined workloads  tab, use the Create workloadCreate workload button to add a warehouse management or

manufacturing execution workload to one of your scale units. For each workload, you must specify the context

of the processes that will be owned by the workload. For warehouse management workloads, the context is a

specific warehouse in a specific site and legal entity. For manufacturing execution workloads, the context is a

specific site in a legal entity.

https://aka.ms/SCMSUM
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The Scale Unit Manager portal in the preview doesn't let you remove workloads from scale units or unassign a scale unit

from a hub after the assignment is made. If you must remove an assignment, reach out to your contact person for

preview program management.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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The manufacturing lifecycle

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

Some business functionality isn't fully supported in the public preview when workload scale units are used.

In manufacturing execution, cloud and edge scale units deliver the following capabilities, even when edge units

aren't connected to the hub:

Machine operators and shop floor supervisors can access the operational production plan.

Machine operators can keep the plan up to date by running discrete and process manufacturing jobs.

The shop floor supervisor can adjust the operational plan.

Workers can access time and attendance for clock-in and clock-out on the edge, to ensure correct worker pay

calculation.

This topic describes how manufacturing execution workloads work with cloud and edge scale units.

As the following illustration shows, the manufacturing lifecycle is divided into three phases: Plan, Execute, and

Finalize.

The Plan phase includes product definition, planning, order creation and scheduling, and release. The release

step indicates the transition from the Plan phase to the Execute phase. When a production order is released, the

production order jobs will be visible on the production floor and ready for execution.

When a production job is marked as completed, it moves from the Execute phase to the Finalize phase. In the

Finalize phase, the registrations from the Execute phase go through an approval workflow, where they are

calculated, approved, and transferred. At that point, the production order is completed. Therefore, the basis for

the workers' pay is generated.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cloud-edge/cloud-edge-workload-manufacturing.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version
file:///T:/eiye/ac1a/dynamics365/supply-chain/cloud-edge/media/mes-phases-large.png


Splitting the Execute phase into a separate workload

Manufacturing execution tasks that can be run on workloads

Working with manufacturing execution workloads on the hub

Manually process raw registrationsManually process raw registrations

As the following illustration shows, when scale units are used, the Execute phase is split out as a separate

workload.

The model now goes from a single-instance installation to a model that is based on the hub and scale units. The

Plan and Finalize phases run as back-office operations on the hub, and the manufacturing execution workload

runs on the scale units. Data is transferred asynchronously between the hub and scale units.

When a production order is released on the hub, all data that is required to process production jobs is

transferred to the scale unit. This data includes production orders, production routes, bills of materials, and

products. Data that isn't related to a production order (such as indirect activities, absence codes, and production

parameters) is also transferred from the hub to the scale unit. As a rule, data that originates from the hub and

that is transferred to the scale unit can be created or updated only on the hub. For example, a new absence code

or indirect activity can't be created on the scale unit—they can be used only for registration. The registrations

that are made on the scale unit during execution are then transferred to the hub, where time and attendance

approval, inventory, and financial updates are processed.

The following manufacturing execution tasks can currently be run on workloads when scale units are used:

Clock-in, log-in, clock-out, and absence

Start job

Bundle jobs

Report progress

Report scrap

Indirect activity

Break

Usually, the processes that are required to run manufacturing execution workloads run automatically to keep the

hub and all the scale units in sync, as needed. However, if you're having trouble, you can manually trigger the

processing of raw registrations that are received from workloads and/or check the registration processing log.

A batch job in Supply Chain Management runs automatically to process all the registrations that have been

file:///T:/eiye/ac1a/dynamics365/supply-chain/cloud-edge/media/mes-phases-workloads-large.png


Check the raw registration processing logCheck the raw registration processing log

Working with manufacturing execution workloads on a scale unit

View the history of manufacturing jobs that have been processed on a scale unitView the history of manufacturing jobs that have been processed on a scale unit

Manufacturing hub to scale unit message processor jobManufacturing hub to scale unit message processor job

received from the workloads. This job creates the required production journals and logbook entries when a

registration is processed for a completed job on the workload.

Although the job usually runs automatically, you can run it manually at any time by signing in to the hub and

going to Production control > Periodic tasks > Backoffice workload management > Process rawProduction control > Periodic tasks > Backoffice workload management > Process raw

registrationsregistrations .

To review the registration processing log, sign in to the hub, and go to Production control > Periodic tasksProduction control > Periodic tasks

> Backoffice workload management > Raw registration processing log> Backoffice workload management > Raw registration processing log. The Raw registrationRaw registration

processing logprocessing log page shows a list of processed raw registrations and the status of each registration.

You can work on any registration in the list by selecting it and then selecting one of the following buttons on the

Action Pane:

ProcessProcess  – Manually process the selected registration. This action can be useful if the Process raw

registrations job hasn't run, or if it failed.

CancelCancel  – Cancel the selected registration.

Usually, the processes that are required to run manufacturing execution workloads run automatically to keep the

hub and all the scale units in sync, as needed. However, if you're having trouble, you can check the history of

orders that have been processed on a scale unit or manually run the Manufacturing hub to scale unit message

processor job.

To review the history of manufacturing jobs that have been processed on a scale unit, sign in to the scale unit

machine, and go to Production control > Periodic tasks > Backoffice workload management >Production control > Periodic tasks > Backoffice workload management >

Manufactur ing jobs processing histor yManufactur ing jobs processing histor y . The Manufactur ing jobs processing histor yManufactur ing jobs processing histor y  page shows the

processing history of the production orders on the scale unit. You can work on any production order in the list

by selecting it and then selecting one of the following buttons on the Action Pane:

ProcessProcess  – Manually process the selected production order.

CancelCancel  – Cancel the selected production order.

The Manufacturing hub to scale unit message processor job processes data from the hub to the scale unit. This

job is automatically started when the manufacturing execution workload is deployed. However, you can run it

manually at any time by going to Production control > Periodic tasks > Backoffice workloadProduction control > Periodic tasks > Backoffice workload
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management > Manufactur ing hub to scale unit message processormanagement > Manufactur ing hub to scale unit message processor .

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Warehouse execution on scale units

Prerequisites

How the WES workload works on scale units

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

Not all warehouse management business functionality is fully supported for warehouses running a workload on a scale

unit. Be sure to use only the processes that this topic explicitly describes as supported.

This feature enables scale units to run selected processes from the warehouse management capabilities. Cloud

scale units run their workloads in the cloud by using dedicated processing capacity in your selected Microsoft

Azure region. For edge scale units, you can run some workloads independently on premises, even while the

scale units are temporarily disconnected from the cloud.

In this topic, warehouse management executions in a warehouse that is defined as a scale unit are known as a

Warehouse execution system (WES).

You must have a Dynamics 365 Supply Chain Management hub and a scale unit that has been deployed with the

warehouse management workload. For more information about the architecture and deployment process, see

Cloud and edge scale units for manufacturing and warehouse management workloads.

For the processes in the warehouse management workload, the data is synced between the hub and the scale

units.

A scale unit can maintain only the data that it owns. The data ownership concept for scale units helps prevent

multi-master conflicts. Therefore, it's important that you understand which processes are owned by the hub and

which are owned by the scale units.

The scale units own the following data:

Wave processing dataWave processing data – Selected wave process methods are handled as part of the scale unit wave

processing.

Work processing dataWork processing data – The following types of work order processing are supported:

Inventor y movementsInventor y movements  (manual movement and movement by template work)

Purchase ordersPurchase orders  (putaway work via a warehouse order when purchase orders are not associated

with loads)

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cloud-edge/cloud-edge-workload-warehousing.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version


Outbound process flow

Inbound process flow

NOTENOTE

Sales ordersSales orders  (simple picking and loading work)

Transfer ordersTransfer orders  (only outbound with simple picking and loading work)

Warehouse order receipt dataWarehouse order receipt data – This data is used only for purchase orders that are manually released

to a warehouse.

L icense plate dataLicense plate data – License plates can be created on the hub and the scale unit. Dedicated conflict

handling has been provided. Note that this data isn't warehouse-specific.

The hub owns the following data:

All source documents, such as sales orders and transfer orders

Order allocation and outbound load processing

The release to warehouse, shipment creation, wave creation, and wave finalization processes

The scale units own the actual wave processing (such as work allocation, replenishment work, and demand work

creation) after the release of the wave. Therefore, warehouse workers can process outbound work by using a

warehouse app that is connected to the scale unit.

The hub owns the following data:

All source documents, such as purchase orders and sales return orders

Inbound load processing

All cost and financial updates

The inbound purchase order flow is conceptually different from the outbound flow. You can operate the same warehouse

on either the scale unit or the hub depending on whether the purchase order has been released to warehouse or not.

Once you have released an order to the warehouse, you can only work with that order while signed in on the scale unit.

If you're using the release to warehouse process, warehouse orders are created, and ownership of the related

receiving flow is assigned to the scale unit. The hub won't be able to register inbound receiving.



Supported processes and roles

Supported WES processes

The worker can run the receiving process by using a warehouse app that is connected to the scale unit. The data

is then recorded by the scale unit and reported against the inbound warehouse order. The creation and

processing of the subsequent putaway will also be handled by the scale unit.

If you aren't using the release to warehouse process, and therefore aren't using warehouse orders, the hub can

process warehouse receiving and work processing independently from scale units.

Not all warehouse management processes are supported in a WES workload on a scale unit. Therefore, we

recommend that you assign roles that match the functionality that is available to each user.

To facilitate this process, a sample role that is named Warehouse manager on workload is included in the demo

data at System administration > Security > Security configurationSystem administration > Security > Security configuration. The purpose of this role is to enable

warehouse managers to access the WES on the scale unit. The role grants access to the pages that are relevant

in the context of a workload that is hosted on a scale unit.

User roles on a scale unit are assigned as part of the initial data synchronization from the hub to the scale unit.

To modify the roles that are assigned to a user, go to System administration > Security > Assign users toSystem administration > Security > Assign users to

rolesroles . Users who act as warehouse managers only on scale units should be assigned only the Warehouse

manager on workload role. This approach will ensure that those users have access only to the supported

functionality. Remove any other roles that are assigned to those users.

Users who act as warehouse managers on both the hub and scale units should be assigned the existing

Warehouse worker role. Be aware that this role grants warehouse workers access to features (such as transfer

order receiving processing) that appear in the user interface (UI) but aren't currently supported on scale units.

The following warehouse execution processes can be enabled for a WES workload on a scale unit:

Selected wave methods for sales and transfer orders (allocation, demand replenishment, containerization,

work creation, and wave label printing)

Processing sales and transfer order warehouse work using the warehouse app (including replenishment

work)

Querying on-hand inventory by using the warehouse app

Creating and running inventory movements by using the warehouse app



NOTENOTE

WARNINGWARNING

Registering purchase orders and doing putaway work by using the warehouse app

The following work order types are currently supported for WES workloads on scale unit deployments:

Sales orders

Transfer issue

Replenishment

Inventory movement

Purchase orders (linked to warehouse orders)

No other types source-documents processing or warehouse work are currently supported on scale units. For

example, for a WES workload on a scale unit, you can't perform a transfer order receiving process (transfer

receipt) or process cycle counting work.

Mobile device menu items and buttons for unsupported functionalities aren't shown in the warehouse app when it is

connected to a scale unit deployment.

When you run a workload on a scale unit, you can't run unsupported processes for that specific warehouse on the hub.

The tables provided later in this topic document the supported capabilities.

Selected warehouse work types can be created both on the hub and on scale units, but can only be maintained by the

owning hub or scale unit (the deployment which created the data).

Even when a specific process is scale unit supported, be aware that all the needed data might not get synchronized from

the hub to the scale unit, or from the scale unit to the hub, which risks resulting in unexpected system processing.

Examples being:

If you use a location directive query that joins a data table record that only exists at the hub deployment.

If you use location status and/or location volumetric load functionalities. This data will not get synchronized between

the deployments and will therefore only work when updating location inventory on-hand on one of the deployments.

The following warehouse management functionality isn't currently supported for scale unit workloads:

Inbound processing of purchase order lines assigned to a load

Inbound processing of purchase orders for a project

Inbound and outbound processing for items that have active tracking dimensions OwnerOwner  and/or Ser ialSer ial

numbernumber

Processing of inventory that has a blocking status value

Changing of an inventory status during any work movement process

Order-committed flexible warehouse-level dimension reservations

Use of Warehouse location status functionality (the data isn't synced between the deployments)

Use of Location license plate positioning functionality

Use of Product filters and Product filter groups, including the Number of days to mix batchesNumber of days to mix batches  setting

Integration with quality management

Processing with catch-weight items

Processing with items only enabled for Transportation management (TMS)

Processing with negative on-hand inventory

Warehouse work processing with custom work types

Warehouse work processing with shipment notes
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Outbound (supported only for sales and transfer orders)Outbound (supported only for sales and transfer orders)

P RO C ESSP RO C ESS H UBH UB W ES W O RKLO A D O N  A  SC A L E  UN ITW ES W O RKLO A D O N  A  SC A L E  UN IT

Source document processing Yes No

Load and transportation management
processing

Yes No

Release to warehouse Yes No

Planned cross docking No No

Shipment consolidation Yes No

Shipment wave processing Yes, but only initialization and
finalization of the wave is handled in
the hub. This means that outbound
transfer and sales order processing
only can get handled by the scale unit.

Maintain shipments for wave Yes No

Warehouse work processing (incl.
license plate print)

No

Cluster picking No Yes

Warehouse work processing with cycle counting threshold triggering

Warehouse work processing with material handling/warehouse automation

Use of product master data image (for example, on the warehouse app)

Some warehouse functionality won't be available for warehouses running the warehouse management workloads on a

scale unit, and also isn't supported on the hub or on the scale unit workload.

Other capabilities can get processed on both, but will require careful use in some scenarios, such as when inventory on-

hand gets updated for the same warehouse on both the hub and scale unit due to the asynchronous data update

process.

Specific functionalities (such as block work) which are supported on both the hub and scale units will only be supported

for the owner of the data.

The following table shows which outbound features are supported, and where they are supported, when the

warehouse management workloads are used in cloud and edge scale units.

No, initialization and finalization
gets handled by the hub and the
Load building and sor tingLoad building and sor ting are
not supported

Note:Note:  Access to the hub is
required to finalize the wave status
as part of the wave processing.

Yes, but only for the above
mentioned supported capabilities.



Manual packing processing, incl.
'Packed container picking' work
processing

No No

Remove container from group No No

Outbound sorting processing No No

Printing of load related documents Yes No

Bill of lading and ASN generation Yes No

Shipment confirm Yes No

Shipment confirmation with "Confirm
and transfer"

No No

Packing slip and invoicing processing Yes No

Short picking (sales and transfer
orders)

No No

Over picking (sales and transfer
orders)

No No

Change of work locations (sales and
transfer orders)

No Yes

Complete work (sales and transfer
orders)

No Yes

Print work report Yes No

Wave label No Yes

Work split No Yes

Work processing - Directed by
'Transport loading'

No No

Reduce picked quantity No No

Reverse work No No

Reverse shipment confirmation Yes No

P RO C ESSP RO C ESS H UBH UB W ES W O RKLO A D O N  A  SC A L E  UN ITW ES W O RKLO A D O N  A  SC A L E  UN IT

InboundInbound

Some processing can be done after
a initial picking process handled by
a scale unit, but not recommended
due to following blocked
operations.

The following table shows which inbound features are supported, and where they are supported, when the

warehouse management workloads are used in cloud and edge scale units.



P RO C ESSP RO C ESS H UBH UB

W ES W O RKLO A D O N  A  SC A L E  UN ITW ES W O RKLO A D O N  A  SC A L E  UN IT
( IT EM S M A RKED " Y ES"  A P P LY  O N LY( IT EM S M A RKED " Y ES"  A P P LY  O N LY
F O R WA REH O USE O RDERS)F O R WA REH O USE O RDERS)

Source document processing Yes No

Load and transportation management
processing

Yes No

Inbound shipment confirmation Yes No

Purchase order release to warehouse
(warehouse order processing)

Yes No

Cancellation of warehouse order lines Yes No

Purchase order item receiving and put
away

Purchase order line receiving and put
away

Return order receiving and put away Yes No

Mixed license plate receiving and put
away

No

Load item receiving No

License plate receiving and put away No

Transfer order item receiving and put
away

Yes No

Note that this only is supported
when no registration has
happened against the line

Yes, when there isn't a warehouse
order

No, when there is a warehouse
order

Yes, when a purchase order isn't
part of a load

Yes, when there isn't a warehouse
order

No, when there is a warehouse
order

Yes, when a purchase order isn't
part of a load

Yes, when there isn't a warehouse
order

No, when there is a warehouse
order

Yes, when there isn't a warehouse
order

No, when there is a warehouse
order

Yes, when there isn't a warehouse
order

No, when there is a warehouse
order



Transfer order line receiving and put
away

Yes No

Cancel work (inbound)

Purchase order product receipt
processing

Yes No

Purchase order receiving with
underdelivery

No, because you can only cancel the
full warehouse order line quantities

Purchase order receiving with
overdelivery

Yes

Receiving with creation of Cross
docking work

No

Receiving with creation of Quality
order work

No

Receiving with creation of Quality item
sampling work

No

Receiving with creation of Quality in
quality check work

No

P RO C ESSP RO C ESS H UBH UB

W ES W O RKLO A D O N  A  SC A L E  UN ITW ES W O RKLO A D O N  A  SC A L E  UN IT
( IT EM S M A RKED " Y ES"  A P P LY  O N LY( IT EM S M A RKED " Y ES"  A P P LY  O N LY
F O R WA REH O USE O RDERS)F O R WA REH O USE O RDERS)

Yes, when there isn't a warehouse
order

No, when there is a warehouse
order

Yes, but only when the
Unregister receipt whenUnregister receipt when
canceling workcanceling work option (on the
Warehouse managementWarehouse management
parametersparameters  page) is cleared

Yes, when there isn't a warehouse
order

No, when there is a warehouse
order

Yes, when there isn't a warehouse
order

No, when there is a warehouse
order

Yes, when there isn't a warehouse
order

No, when there is a warehouse
order

Yes, when there isn't a warehouse
order

No, when there is a warehouse
order

Yes, when there isn't a warehouse
order

No, when there is a warehouse
order

Yes, when there isn't a warehouse
order

No, when there is a warehouse
order



Receiving with quality order creation No

Work processing - Directed by Cluster
putaway

Yes No

Work processing with Short pick Yes No

License plate loading Yes No

P RO C ESSP RO C ESS H UBH UB

W ES W O RKLO A D O N  A  SC A L E  UN ITW ES W O RKLO A D O N  A  SC A L E  UN IT
( IT EM S M A RKED " Y ES"  A P P LY  O N LY( IT EM S M A RKED " Y ES"  A P P LY  O N LY
F O R WA REH O USE O RDERS)F O R WA REH O USE O RDERS)

Warehouse operations and exception handingWarehouse operations and exception handing

P RO C ESSP RO C ESS H UBH UB W ES W O RKLO A D O N  A  SC A L E  UN ITW ES W O RKLO A D O N  A  SC A L E  UN IT

License plate inquire Yes Yes

Item inquire Yes Yes

Location inquire Yes Yes

Change warehouse Yes Yes

Movement Yes Yes

Movement by template Yes Yes

Warehouse transfer Yes No

Create transfer order from warehouse
app

Yes No

Adjustment (in/out) Yes No

Inventory status change Yes No

Cycle counting and Counting
discrepancy processing

Yes No

Reprint label (license plate printing) Yes Yes

License plate build Yes No

License plate break Yes No

Yes, when there isn't a warehouse
order

No, when there is a warehouse
order

The following table shows which warehouse operations and exception handing features are supported, and

where they are supported, when the warehouse management workloads are used in cloud and edge scale units.



Pack to nested license plates Yes No

Driver check in Yes No

Driver check out Yes No

Change batch disposition code Yes Yes

Display open work list Yes Yes

Consolidate license plates Yes No

Min/max and zone threshold
replenishment processing

Yes Yes

Slotting replenishment processing Yes Yes

Block and unblock work Yes Yes

Change user Yes Yes

Change work pool on work Yes Yes

Cancel work Yes Yes

P RO C ESSP RO C ESS H UBH UB W ES W O RKLO A D O N  A  SC A L E  UN ITW ES W O RKLO A D O N  A  SC A L E  UN IT

ProductionProduction

P RO C ESSP RO C ESS H UBH UB W ES W O RKLO A D O N  A  SC A L E  UN ITW ES W O RKLO A D O N  A  SC A L E  UN IT

Release to warehouse
Production wave processing
Raw material picking
RAF and finished goods put away
Co-product and by-product put

away
Kanban put away
Kanban picking
Start production order
Production scrap
Production last pallet
Register material consumption
Empty kanban

Yes No

Recommendation is not to include
the same locations as part of the
queries

Note that the setup must be done
on the scale unit

Warehouse management production scenarios aren't currently supported on scale unit workloads, as indicated

in the following table.

All warehouse management
processes that are related to
production. Here are some
examples:



Maintaining scale units for WES

NOTENOTE

Several batch jobs run on both the hub and scale units.

On the hub deployment, you can manually maintain the batch jobs. You can manage the following batch jobs at

Warehouse management > Periodic tasks > Back-office workload managementWarehouse management > Periodic tasks > Back-office workload management:

Process work status update events

Scale unit to hub message processor

Register source order receipts

Complete warehouse orders

Process quantity update responses for warehouse order lines

On the workload in scale units, you can manage the following batch jobs at Warehouse management >Warehouse management >

Periodic tasks > Workload managementPeriodic tasks > Workload management:

Process wave table records

Warehouse hub to scale unit message processor

Process quantity update requests for warehouse order lines
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IMPORTANTIMPORTANT

WARNINGWARNING

What are warehouse orders?

IMPORTANTIMPORTANT

Create a warehouse order

Cancel a warehouse order

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

Not all business functionality is fully supported in the public preview when scale unit workloads are used. If you're using

scale units, be sure to use only those processes that this topic explicitly describes as supported.

Warehouse orders are a type of order that was created to support hub and scale unit warehouse deployments.

They let you receive inventory when you're running a warehouse workload on a scale unit. They are currently

used only with purchase orders.

Warehouse orders are used as part of warehouse management processing, such as when the warehouse app is

used to register physical on-hand inventory during processing of an inbound purchase order. Warehouse orders

are created as part of the Release to warehouse process that is available for purchase orders that specify a scale

unit warehouse and items that are enabled to use warehouse management processes.

Warehouse orders are available only in deployments that use warehouse management workloads for cloud and edge scale

units.

To create a warehouse order, follow these steps.

1. Sign in to the instance of Microsoft Dynamics 365 Supply Chain Management that is running on the hub.

(You must initiate the Release to warehouse process while you're signed in on the hub.)

2. Go to Procurement and sourcing > Purchase orders > All purchase ordersProcurement and sourcing > Purchase orders > All purchase orders .

3. On the Action Pane, on the WarehouseWarehouse tab, in the ActionsActions  group, select Release to warehouseRelease to warehouse.

4. To view the related warehouse order lines, open the relevant purchase order, select a line in the PurchasePurchase

order linesorder lines  section, and then, on the toolbar, select Warehouse > Warehouse order linesWarehouse > Warehouse order lines . To view all the

lines, go to Warehouse management > Inquir ies and repor ts > Warehouse order linesWarehouse management > Inquir ies and repor ts > Warehouse order lines .

As part of the Release to warehouse process, purchase order inventory transactions are linked to warehouse

orders and locked from being updated by the hub. If you released to the warehouse by mistake, or if you have

some other reason to reverse the creation of warehouse order lines, you can request to cancel warehouse order

lines.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cloud-edge/cloud-edge-warehouse-order.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version
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Monitor a warehouse order

NOTENOTE

To cancel warehouse order lines, follow these steps.

1. Sign in to the Supply Chain Management instance that is running on the hub.

2. Go to Warehouse management > Inquir ies and repor ts > Warehouse order linesWarehouse management > Inquir ies and repor ts > Warehouse order lines .

3. Select the relevant line.

4. On the Action Pane, select Cancel warehouse order linesCancel warehouse order lines .

The request to cancel lines will be denied for any lines that are already pending cancellation or that are actively being

processed at a warehouse that is running its workload on a scale unit.

In the Warehouse order linesWarehouse order lines  view, you can monitor the progress of inbound receiving by reviewing the

values in the Quantity left to receiveQuantity left to receive column. To view details that are related to work that is done by using the

warehouse app, follow one of these steps.

Go to Warehouse management > Inquir ies and repor ts > Warehouse order linesWarehouse management > Inquir ies and repor ts > Warehouse order lines , and use the filter

to find the lines that you're looking for.

Go to Procurement and sourcing > Purchase orders > All purchase ordersProcurement and sourcing > Purchase orders > All purchase orders , and open the relevant

purchase order. In the Purchase order linesPurchase order lines  section, select one or more lines, and then, on the toolbar,

select Warehouse > Warehouse receipt entr iesWarehouse > Warehouse receipt entr ies .
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NOTENOTE

Asset Management is an advanced module for managing assets and maintenance jobs in Dynamics 365 Supply

Chain Management. Asset Management integrates seamlessly with several modules in Finance and Operations

apps.

The image below is an illustration of the interfaces to other modules in Finance and Operations.

Asset Management enables you to efficiently manage and carry out tasks related to managing and servicing

many types of equipment in your company, for example, machines, production equipment, and vehicles. Asset

Management supports solutions across numerous industries.
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Overview

This topic describes functional locations and assets in Asset Management. Asset Management is an advanced

module for managing assets and maintenance jobs in Dynamics 365 Supply Chain Management.

Asset Management is integrated seamlessly with several modules with other Finance and Operations apps. The

following illustration shows the interfaces with other modules.

Asset Management lets you efficiently manage and perform all tasks that are related to managing and servicing

many types of equipment in your company. This equipment includes machines, production equipment, and

vehicles. Asset Management also supports solutions across numerous industries.

The following illustration shows an overview of the main functionality that is covered by Asset Management.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/overview/functional-locations-and-objects.md


Functional locations and assets
Functional locations are used to manage assets on locations. This management includes tracking of asset costs

on functional locations. Functional locations are structured hierarchically, and locations can have sub-locations.

The structure of functional locations is static. In other words, locations can't change place. Assets can be installed

on functional locations and, as required, can be installed on other functional locations later.

Asset costs always follow the location of the asset. In other words, if you install an asset on a new functional

location, the asset automatically uses the financial dimensions that are related to the new functional location.

Therefore, asset costs are always related to the functional location that the asset is currently installed on. This

automatic handling of financial dimensions helps guarantee complete tracking of costs when your company

does project controlling and reporting on functional locations.

The way that you build your hierarchy of functional locations depends on your company's requirements for

maintaining internal equipment or servicing customer equipment. The following figure shows an example of

functional locations that are based on geographical locations.



The following figure shows an example of functional locations that are based on customers.
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This topic describes assets and work orders in Asset Management. Assets and work orders are the central parts

of Asset Management. An asset is a machine or machine part that requires continuous maintenance and service.

Assets can be created in a hierarchical structure, and they can be related to functional locations. Maintenance

jobs can be planned at all levels in the asset structure.

Various data, such as product information and asset specification, and required maintenance plans are set up on

each asset. The following illustration shows an overview of asset data and the affiliation of assets to job types.

Red text is used for examples that show inheritance and dependencies.

Every work order has a work order type, such preventive maintenance, corrective maintenance, or inspection.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/overview/objects-and-work-orders.md


The work order contains one or more work order jobs. Every work order job defines a job that must be

performed on an asset and a related job type. Examples of related job types include 10,000 km, 50,000 km, 1-

year overhaul, and safety inspection. One work order can be related to multiple assets.

The following illustration shows an overview of the key data in a work order.

A work order can be related to another work order, and job types can contain succeeding jobs that create a work

order. In general, there are no dependencies between work orders. Therefore, they can change their work order

lifecycle state and can be scheduled independently of each other.

Work orders can be created in various ways that are related to corrective, preventive, or reactive maintenance.

You can also create work orders manually. The following illustration shows an overview of the process for

automatic or manual creation of work orders.



Several steps must be completed when you want to schedule and run a maintenance job on a work order. The

following illustration shows an overview of the processing for a work order.



NOTENOTE
In general, when you work in Dynamics 365 Supply Chain Management and the Asset ManagementAsset Management  module, you

select NewNew to create a new record, you select EditEdit  to update an existing record, and you select SaveSave to save new or

edited data.
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Set up functional location lifecycle states

NOTENOTE

NOTENOTE

Set up functional location lifecycle models

This topic describes how to set up functional location lifecycle states and lifecycle models in Asset Management.

Functional location lifecycle states define the states that a functional location can go through, for example,

created, active, and ended. You are able to view all functional locations, regardless of their lifecycle state, in the

All functional locationsAll functional locations  list page. You can change the state of a functional location by selecting it in the AllAll

functional locationsfunctional locations  list page and selecting Update functional location stateUpdate functional location state.

1. Select Asset managementAsset management > SetupSetup > Functional locationsFunctional locations  > L ifecycle statesLifecycle states .

2. Select NewNew  to create a new functional location state.

3. Insert the state ID in the L ifecycle stateLifecycle state field and a name for the functional location state in the NameName field.

In the L ifecycle modelsL ifecycle models  field, you can see the number of functional location lifecycle models that uses the

functional location state.

4. On the GeneralGeneral  FastTab, select "Yes" on the ActiveActive toggle button if the functional location should be active at

this state.

5. Select "Yes" on the Create assetsCreate assets  toggle button if it should be possible to automatically create an asset with

the same name as the functional location and install it on the functional location at this state.

This toggle button relates to the Asset typeAsset type field on the GeneralGeneral FastTab in the Functional location typesFunctional location types form

(Asset managementAsset management  > SetupSetup > Functional locationsFunctional locations > Functional location typesFunctional location types). 6. Select "Yes" on the

Rename locationRename location toggle button if it should be possible to change the name of the functional location at this state. 7.

Select "Yes" on the New sub locationsNew sub locations toggle button if it should be possible to add new sub locations to the functional

location at this state. 8. Select "Yes" on the Install assetsInstall assets  toggle button if it should be possible to install assets on the

functional location at this state. 9. Select "Yes" on the Delete functional locationDelete functional location toggle button if it should be possible

to delete the functional location at this state. 10. Select an asset state in the Lifecycle stateLifecycle state field if you want the asset

lifecycle state for all assets installed on the functional location to be automatically updated at this state. Example: If you

close down a functional location, and set the functional location lifecycle state to "Ended", you may want to automatically

change the lifecycle state of the assets installed on that functional location to "Not in use".

Functional location lifecycle states, lifecycle models, and types are related and used in the same way as work order lifecycle

states, work order lifecycle models, and work order types.

When you have created the lifecycle states required for your functional locations, they can be divided into

groups. This is done to create the lifecycle model flow that may be used for different types of functional

locations. As a minimum, one standard functional location lifecycle model should be created.

1. Select Asset managementAsset management > SetupSetup > Functional locationsFunctional locations  > L ifecycle modelsL ifecycle models .

2. Select NewNew  to create a new lifecycle model.

3. Insert the lifecycle model ID in the L ifecycle modelL ifecycle model  field and a name for the lifecycle model in the NameName

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/setup-for-functional-locations/functional-location-stages.md


NOTENOTE

field. In the Functional location typesFunctional location types  and L ifecycle statesLifecycle states  fields, you can see the number of functional

location types that uses the lifecycle model and the number of states selected in the lifecycle model.

4. On the L ifecycle statesLifecycle states  FastTab, select the states that should be included in the model. This is done by

clicking on a state in the L ifecycle states remainingLifecycle states remaining section and clicking the  button.

5. If you want to select all the available states for a model, click the  button. All states are transferred to the

Lifecycle states selectedLifecycle states selected section.

6. If you want to remove a selected state from the model, select the state in the L ifecycle states selectedLifecycle states selected

section and then select the  button.

7. Select L ifecycle state updatesLifecycle state updates  to define which lifecycle states can follow a selected state.
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Create attribute types

This topic explains how to create attribute types in Asset Management. Attributes are used to describe the

properties of various elements. You can set up attributes on the following elements:

Functional location types

Create functional locations

Asset types

Assets

The attributes that you can set up vary, depending on the element. For example, for a functional location, you

can set up attributes for the configuration and physical size of the location. For an asset type or an asset, you can

set up attributes for engine volume, power consumption, and maximum load capacity under different

conditions.

You can create your own attribute types. Additionally, you can transfer product dimensions to the Attr ibuteAttr ibute

typestypes  page.

1. Select Asset managementAsset management > SetupSetup > Attr ibute typesAttr ibute types .

2. The first time that you set up attribute types, select Create product dimensionsCreate product dimensions  to automatically

transfer standard product dimensions.

3. Select NewNew  to create a new attribute type.

4. In the Attr ibute typeAttr ibute type field, enter a name for the attribute type.

5. In the Descr iptionDescr iption field, enter a description.

6. In the UnitUnit field, select the relevant attribute unit, as required.

7. In the Data typeData type field, select a data type for the unit.

8. If you selected Str ingStr ing as the data type, follow these steps to create values for the attribute type:

a. Select the attribute type, and then select ValuesValues .

b. In the Attr ibute valuesAttr ibute values  field, select NewNew .

c. In the Attr ibute typeAttr ibute type field, select an attribute type (dimension).

d. In the ValueValue field, enter a related value.

e. In the Descr iptionDescr iption field, enter a description.

f. Save the record.

g. Return to the Attr ibute typesAttr ibute types  page.

9. Save the record.

The Functional location typesFunctional location types  field shows the number of functional locations that are using the

attribute type. The Asset typesAsset types  field shows the number of asset types that are using it.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/setup-for-functional-locations/specification-types.md
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NOTENOTE

Create a default functional location type

Create Functional Location Types

This topic describes how to create functional location types in Asset Management. Functional location types are

used to manage requirements for functional locations, including how assets are installed on a functional

location. You can set up asset types, maintenance plans, functional location attributes, and asset attribute

requirements to be used on a functional location that uses the specific functional location type. When you create

a functional location, the functional location type is mandatory.

In order to work with functional locations, you must create a default functional location to be used only for the purpose of

creating new assets. For that default functional location, you should create a default functional location type that is really

simple and allows multiple assets to be installed on the default functional location. See Create functional locations for

more information on how to set up functional locations.

This procedure shows how to create a default functional location type to be used for a default functional

location.

1. Select Asset managementAsset management > SetupSetup > Functional locationsFunctional locations  > Functional location typesFunctional location types .

2. Select NewNew  to create a functional location type.

3. Insert a functional location type ID in the Functional location typeFunctional location type field, for example, "Default", and a name

in the NameName field.

4. Select a lifecycle model in the Functional location lifecycle modelFunctional location lifecycle model  field.

5. Select "Yes" on the Multiple assetsMultiple assets  toggle button to allow more assets to be installed on a functional

location (the default functional location) using this type.

Now, the default functional location type to be used only on a default functional location is created. You should

not add any more requirements or restrictions to this default functional location type.

1. Select Asset ManagementAsset Management > SetupSetup > Functional locationsFunctional locations  > Functional location typesFunctional location types .

2. Select NewNew  to create a functional location type.

3. Insert a functional location type ID in the Functional location typeFunctional location type field and a name in the NameName field.

4. Select a lifecycle model in the Functional location lifecycle modelFunctional location lifecycle model  field. Refer to Functional location

lifecycle states for more information on functional location lifecycle states and lifecycle models.

5. Select "Yes" on the Multiple assetsMultiple assets  toggle button if it should be possible to install several assets on a

functional location using this functional location type. If you select "No", you can only install one asset on a

functional location using this functional location type.

6. Select "Yes" on the Update asset dimensionUpdate asset dimension toggle button if you want assets installed on a functional

location of this type to automatically use the financial dimensions related to the functional location. This

means that if you change financial dimensions in the Create functional locations form, and the functional

location uses a functional location type with this toggle button set to "Yes", financial dimensions are

automatically updated on all assets installed on that functional location.

7. The Asset typeAsset type field is used if you want to automatically create one asset for the functional location with the
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same ID and name as the functional location you are creating. For example, this may be relevant if you create

a static functional location, such as a building or a pipeline. In that case, select the asset type you want to use

for the automatically created asset. Remember that if you make a selection in this field, the Multiple assetsMultiple assets

toggle button must be set to "No".

8. On the Asset typesAsset types  FastTab, select the asset types to be related to the functional location type. Select AddAdd

lineline and select the asset types. If you add asset types here, only assets using those asset types can be

installed on a functional location using this functional location type. If no asset types are selected on the

Asset typesAsset types  FastTab, all asset types may be installed.

9. On the Maintenance plansMaintenance plans  FastTab, select the maintenance plans that should automatically be set up on

new functional locations using this functional location type. Select Add lineAdd line and select the maintenance

plans. If you add maintenance plans here, only those plans can be used on a functional location using this

functional location type.

10. On the Asset attr ibute requirementsAsset attr ibute requirements  FastTab, set up the asset attributes that should automatically be set

up on new functional locations using this functional location type. Select Add lineAdd line and select the attribute.

These attribute requirements function as guidelines. They are not validated against attributes set up on an

asset (Asset managementAsset management > CommonCommon > AssetsAssets  > All assetsAll assets  > select asset in the list page > GeneralGeneral  tab

> Attr ibutesAttr ibutes  button). The attribute requirements are shown when you install assets on functional locations.

11. On the Permitted typesPermitted types  FastTab, select the functional location types that should be valid for sub functional

location types related to a parent functional location type, which uses the selected functional location type.

12. On the Attr ibutesAttr ibutes  FastTab, select the functional location attributes that should automatically be set up on

functional locations using this functional location type. Select Add lineAdd line and select the attribute.

On the GeneralGeneral FastTab, you can get an overview of the number of asset types, maintenance plans, asset attribute

requirements, permitted types, attributes, and functional locations set up on the functional location type. The FunctionalFunctional

locationslocations field shows the number of functional locations that use the functional location type. You can use the CopyCopy

button to copy settings from a functional location type to the selected functional location type.
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This topic provides an overview of functional locations in Asset Management. Functional locations are elements

of a technical structure, such as the functional units in a system. Functional locations are created hierarchically,

and you install assets on them. The setup of functional locations in your company depends on the company's

requirements.

Here are some examples of how you can use functional locations:

FunctionalFunctional  – The functional locations can be user-oriented and used to manage assets that have similar

behavior.

Process-relatedProcess-related – The functional locations can be workflow-oriented.

SpatialSpatial  – The functional locations can represent geographical locations or sites.

Each functional location is managed independently in Asset Management. Here are some of the useful features

of functional locations:

Set up functional location specifications.

Set up asset specification requirements.

Set up maintenance sequences for preventive and reactive maintenance.

Manage installed assets.

Track active requests and work orders that are related to installed assets.

Track faults that are registered on assets.

Track maintenance costs on the assets that are related to a functional location at any given time.

Functional locations provide traceability of assets in relation to requests, work orders, fault registrations,

condition assessments, production stop registrations, and asset counter registrations.

Even if an asset is installed on various functional locations during its lifetime, the costs can be related to each location. In

other words, asset costs are always related to the functional location that the asset was installed on at a given time.

Functional locations are notnot flexible. Therefore, after you set up a functional location hierarchy, you can't move

locations around in it.

After you create a functional location hierarchy, the next step is to install assets on it. For more information, see

Install assets on functional locations.

Select Asset managementAsset management > CommonCommon > Functional locationsFunctional locations  > All functional locationsAll functional locations  to open the AllAll

functional locationsfunctional locations  list page. This page shows all functional locations and some of the information that is

related to each. To view only active functional locations, select Active functional locationsActive functional locations . To view only the

functional locations that you're related to as a worker, select My active functional locationsMy active functional locations . (This relation is

set up on the WorkersWorkers  page. For more information, see Maintenance workers and worker groups.)

On the All functional locationsAll functional locations  list page, select a link in the Functional locationFunctional location column to view the details

of the selected record. To edit the functional location, select the EditEdit button. The details view shows detailed
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Edit Switch between edit mode and view mode for the page.

New Create a new functional location.

Delete Delete the selected functional location.

Rename Rename the selected functional location.

Copy functional location structure Copy the functional location hierarchy.

Install asset Install an asset, including child assets, on the functional
location.

Replace asset Replace the asset hierarchy with another asset hierarchy on
the functional location.

Cost control Open the Functional location cost controlFunctional location cost control page, where
you can do a cost calculation for the selected functional
location.

Hour control Open the Functional location hour controlFunctional location hour control page, where
you can do a cost calculation for the selected functional
location.

Assets Open the All assetsAll assets  page, where you can view a list of
assets that are related to the selected functional location.

Requests Open the Active requestsActive requests  page, where you can view a list
of requests that are related to the selected functional
location.

Work orders Open the Active work ordersActive work orders  page, where you can view a
list of work orders that are related to the selected functional
location.

Faults Open the Asset faultsAsset faults  page, where you can view a list of
asset fault registrations that are related to the selected
functional location.

Update functional location state Update the stage of the selected functional location.

Lifecycle state log View a log that shows the stages of the selected functional
location.

information that is related to the location. It also includes a Related informationRelated information pane on the right. This pane

shows the functional location hierarchy. You can expand and collapse the Related informationRelated information pane.

The buttons on the Action Pane are organized on tabs. The following table briefly describes the buttons that are

related to Asset Management.
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Create functional locations

This topic explains how to create a functional location in Asset Management.

When you create a functional location structure, be aware once you have created a functional location, you

cannot move it from the original location. This means that you should carefully consider the structure of your

functional locations before you start creating them in Asset Management. If you regret a functional location, you

can delete it, provided that it has not yet been taken into use.

To be able to work with functional locations, you start by creating two "categories" of functional locations:

Create one default functional location with not sub locations. This functional location is used only as the

standard location for assets when you create new assets.

Create the functional location structures required for managing maintenance jobs in your company.

When you use functional locations, start by creating one default location to be used when you create new assets.

This functional location is the one you select in Asset managementAsset management > SetupSetup > Asset managementAsset management

parametersparameters  > AssetsAssets  link > Default functional locationDefault functional location field. The default functional location can be used

when you create new assets, and you have not yet set up a functional location structure for those assets.

1. Select Asset managementAsset management > CommonCommon > Functional locationsFunctional locations  > All Functional locationsAll Functional locations .

2. In All functional locationsAll functional locations , select NewNew .

3. Insert an ID in the Functional locationFunctional location field, for example, "0000" or "Default", to indicate that this is a

special functional location.

4. Insert name for the default functional location in the NameName field.

5. Do not select a parent in the ParentParent field – leave this field blank.

6. In the Functional location typeFunctional location type field, select the functional location type to be used for the default

functional location. See Functional location types for more information on how to set up functional location

types.

7. Select OKOK. You should not add further data to this functional location as it is only used as a temporary

location for new assets until you install the assets on the functional locations used by your company.

The following procedure describes how you create the functional locations required for maintenance

management in your company.

1. Select Asset managementAsset management > CommonCommon > Functional locationsFunctional locations  > All Functional locationsAll Functional locations . You can

create a functional location from grid view or details view.

2. Select the NewNew  button.

3. Insert an ID in the Functional locationFunctional location field.

4. Insert a name for the functional location in the NameName field.

5. If the functional location is a sub location in a structure, select the parent location in the ParentParent field.

6. Select a type in the Functional location typeFunctional location type field.

7. Select OKOK.

8. Select the functional location and click the EditEdit button to add further information.
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Address

Workers

Depending on your setup of functional location lifecycle states, you may have to create all sub locations for a functional

location, and then change the functional location lifecycle state before you can start installing assets. See Install assets on

functional locations for more information on asset installation. See Functional location lifecycle states to learn more about

setup of functional location lifecycle states.

In Details view, you will see FastTabs on which you can add and edit information about the functional location.

This section provides an overview of parent and child information in the functional location structure. In the

DetailsDetails  section, you can see the number of asset attributes, maintenance plans, and assets related to the

functional location. In the Inventor yInventor y  section, you can select the site and warehouse to which the functional

location is related. Site and warehouse is used in connection with work order item forecasts. When creating an

item forecast, site and warehouse information from the functional location of the asset is automatically used. In

the L ifecycle stateLifecycle state section, information about the functional location lifecycle state is displayed.

Refer to Install assets on functional locations for more information on asset installation. You can use the ViewView

button on this FastTab to show more fields on the FastTab. The Valid fromValid from and Sub assetSub asset fields can be shown

in the grid.

On this FastTab you can add specific attribute requirements for the assets that you install on the functional

location. These requirements are for information purposes only. They do not prevent you from installing assets

with other attribute requirements. Select Add lineAdd line and select the attribute type. Then you insert the relevant

ValueValue, select a threshold in the Threshold cr iter iaThreshold cr iter ia field and save the record.

Here you can add maintenance plans and maintenance rounds to the functional location, including a start date.

The assets installed on a functional location may have other maintenance plans set up. All maintenance plans

and maintenance rounds can be used for scheduling asset calendar entries for a functional location and its

currently installed assets.

If you update the setup of asset types, asset brands, and asset models on maintenance plans in All functionalAll functional

locationslocations detail view > Maintenance plansMaintenance plans FastTab after you have scheduled maintenance plans, existing maintenance

schedule entries related to that functional location are automatically deleted. In order to create new schedule entries,

which correspond with the updated maintenance plan setup on the functional location, you must run a new maintenance

plan schedule for that functional location.

Insert the functional location address on the AddressAddress  FastTab. Addresses on functional locations are inherited,

meaning if a sub location has no address defined, the address of the parent location is used.
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Financial dimensions

Copy a functional location structure
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Delete a Functional Location

On this FastTab, you can add workers affiliated with the functional location, and you can select a functional

location as primary for the worker.

On this FastTab, you can set values for functional location attributes. These attributes can be used to describe

properties or characteristics pertinent to the functional location, for example, structural properties, building

type, area descriptions, or location above or under ground.

Select Add lineAdd line and select the attribute type. Next, insert the ValueValue related to the attribute type and save the

record.

You can select financial dimensions for the functional location. Functional location types can be set up to allow

for automatic update of financial dimensions from a functional location. This means that assets installed on a

financial dimension automatically get the financial dimensions for the functional location. This is useful if you

want different cost centers, depending on locations.

When data regarding S iteSite, WarehouseWarehouse, AddressAddress , and Financial dimensionsFinancial dimensions  are updated on a parent

functional location, the related sub functional locations can be updated accordingly if you make that selection

during the update. A dialog opens, providing you with the update options.

If your company has several functional locations with similar location structures, you can use the copy function

in Asset Management to quickly create a number of similar location hierarchies. When you copy a specific

functional location or an entire structure, the new location or structure has the same name as the one you

copied. After the copy procedure is done, you can easily change the name or other settings on the new

functional location, provided that the functional location lifecycle state selected for the new functional location

allows it.

1. In All functional locationsAll functional locations , select the functional location you want to copy. For example, you select a top

location (parent) if you want to copy the entire functional location structure including sub locations.

2. Select the Copy functional location structureCopy functional location structure button. The location you selected in the list page is shown

in the Copy fromCopy from field.

3. Insert the name of the new location in the New functional locationNew functional location field.

4. In the Parent to paste underParent to paste under  field, you should only insert a parent ID if the location you are creating should

be part of an existing functional location structure.

5. Click OKOK. The new functional location structure is shown in All functional locationsAll functional locations .

When you copy a functional location structure, functional location lifecycle states in the new structure are set to the "first

state" that you have created for functional locations. Whether you can rename or delete a functional location using the

RenameRename and DeleteDelete buttons in All functional locationsAll functional locations , depends on the current lifecycle state of the functional

location.

A functional location with related sub locations can be deleted if no assets have been installed on any of the

functional locations you are trying to delete, and if the current functional location lifecycle state allows it.

1. In All functional locationsAll functional locations , select the functional location you want to delete.
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2. If required, update the functional location to a functional location lifecycle state that allows deletion of a

functional location.

3. Select DeleteDelete.

If you cannot delete a functional location, instead you can handle deletion by setting up a functional location lifecycle

state for this purpose. For example, you can set up a "Scrapped" or "Deleted" stage, which should not be an active stage,

in the Functional location lifecycle statesFunctional location lifecycle states form.
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Install an asset structure on a functional location

After you've created functional location structures, the next step is to install assets on the relevant functional

locations. This topic explains how to install assets on those functional locations in Asset Management. For

information about how to create assets, see Introduction to assets.

If you've created an asset structure, the whole asset structure must be installed on a functional location.

Therefore, only parent assets (top-level assets that have no parent asset) can be selected on a functional

location. All related child assets (sub-assets) will also be installed on the functional location. When you install

assets on a functional location, the financial dimensions of the functional location might be automatically

transferred to them, depending on the setup on the functional location type that is selected for the functional

location. For more information about how to set up functional location types, see Functional location types.

You can set up asset types on the functional location type that is used for a functional location. In this case, when you

install assets on the functional location, only parent assets that have the same asset type are shown in the list of assets

that can be installed on the functional location.

After you've installed assets on a functional location, you can replace a parent asset or an asset structure as you

require. As when you install assets, you select a parent asset to replace. All related child assets will also be

replaced.

1. Select Asset managementAsset management > CommonCommon > Functional locationsFunctional locations  > All Functional locationsAll Functional locations  or

Active functional locationsActive functional locations .

2. Select the functional location to install an asset on.

3. Select Install assetInstall asset.

The Attr ibutesAttr ibutes  section shows a list of the asset attribute requirements that are set up on the functional

location type that is selected for the functional location. The attributes are for informational purposes

only. The system doesn't validate the attributes against the asset attributes that are set up on the asset

that you're installing. You must do that validation after you select an asset in the AssetAsset field.

4. In the AssetAsset field, select the parent asset to install. All related child assets are automatically included in

the installation.

The Asset attr ibutesAsset attr ibutes  section to the right of the asset list shows the asset attributes that are related to

the selected asset.

5. In the EffectiveEffective field, select the date and time that the asset installation is valid from. After that date and

time, costs for the asset and related sub-assets will be related to the functional location.
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The asset attributes that are set up on the asset are added to the AttributesAttributes section. For example, the WeightWeight

attribute requirement has been added as a requirement on both the asset and the functional location. If the asset

has attribute requirements of the same type as the functional location, the values of the asset's attribute

requirements are entered in the ValueValue fields. Therefore, you can validate the asset values against the attribute

requirements that are set up on the functional location. The attribute requirements that are set up on the

functional location are marked with a check mark.

6. Select OKOK.

To change the installation of an asset by installing it on a new functional location, follow steps 1 through 6 of this

procedure. When you install an asset on a new functional location, the asset is automatically uninstalled from the

previous functional location. Any active maintenance requests or work orders that were created on the asset

before you installed it on a new functional location are notnot  automatically transferred to the new functional

location. If those maintenance requests and work orders are still required for the asset, you must manually re-

create them after the asset is installed on the new location.

7. To view a list of all the assets, including sub-assets, that are installed on the functional location, select the

functional location on the All Functional locationsAll Functional locations  page, and then select AssetsAssets .

8. To view a list of active maintenance requests, active work orders, or fault registrations that are related to

the assets that are installed on a functional location, select the functional location on the All FunctionalAll Functional

locationslocations  page, and then select RequestsRequests , Work ordersWork orders , or FaultsFaults .

When asset-related data is changed, it's automatically updated on the functional location that the asset is installed on.

This automatic update pertains to changes to maintenance requests, work orders, asset fault registrations, maintenance

downtime registrations, and asset measure registrations.

You can set up functional location stages and functional location types to handle the automatic creation of one

asset on a functional location. The asset gets the same ID and name as the functional location. This functionality

might be useful when you're handling maintenance on a large, static asset, such as a building.

Before you can automatically create an asset on a functional location, the following setup data must be available:

Create a functional location type to handle the automatic creation of an asset. In the Asset typeAsset type field, select

an asset type. For more information, see Functional location types.

Create a functional location lifecycle state to handle the automatic creation of an asset. Set the Create assetCreate asset

option to YesYes . For more information, see Functional location lifecycle states.

After the setup data is available, you're ready to create an asset.

1. On the All Functional locationsAll Functional locations  page, make sure that the functional location where you want the asset to

be automatically created uses the functional location type that you created for this purpose.

2. Select the functional location in the list.

3. Select Update functional location stateUpdate functional location state, and then select the lifecycle state that you created for this

purpose. One asset is now automatically installed on the functional location. This asset has the same name as

the functional location.



NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Asset types
2/18/2021 • 7 minutes to read • Edit Online

Create an asset type

This topic explains how to create asset types. It also describes the elements that are related to asset types. Asset

types are used as general categories for assets. Examples include CNC machines, measuring equipment, and

truck engines. Asset types are used to manage the maintenance job types (maintenance tasks), asset lifecycle

states, counters, asset attributes, condition assessment templates, and asset models that can be selected for an

asset. When you create an asset, you must specify the asset type.

For each asset type, variations of the asset type setup can be created. For example, if you have an asset type that

is named TrucksTrucks , you can create variations of that asset type for different asset manufacturers and asset models.

To each asset type setup, you can add the required spare parts and maintenance plans.

First, you set up the required asset types. Next, you create the asset models that should be related to the asset

types. Finally, on the Asset type defaultsAsset type defaults  page, you create all the variations of asset types that are required for

your equipment.

1. Select Asset managementAsset management > SetupSetup > Asset typesAsset types  > Asset typesAsset types .

2. Select NewNew  to create an asset type.

3. In the Asset typeAsset type field, enter an asset type ID.

4. In the NameName field, enter a name.

5. In the Asset lifecycle modelAsset lifecycle model  field, select an asset lifecycle model. For more information about asset

lifecycle states and asset lifecycle models, see Asset lifecycle states.

6. Set the TotalTotal  option to YesYes  if summarized key performance indicator (KPI) values should be calculated for

assets that have this asset type.

7. Select SaveSave.

8. On the Maintenance job typesMaintenance job types  FastTab, select the maintenance job types that should be related to the

asset type:

To select a maintenance job type, select it in the Maintenance job types remainingMaintenance job types remaining field, and then

select the right arrow button  to move it to the Maintenance job types selectedMaintenance job types selected section.

To select all available maintenance job types, select the  button. All maintenance job types are

transferred from the Maintenance job types remainingMaintenance job types remaining field to the Maintenance job typesMaintenance job types

selectedselected field.

To cancel the selection of a maintenance job type, select it in the Maintenance job types selectedMaintenance job types selected

field, and then select the left arrow button  to move it to the Maintenance job types remainingMaintenance job types remaining

field.

9. You can also select the counters that should be related to the asset type. On the CountersCounters  FastTab, make

your selections by using the methods that are described for maintenance job types in step 8. For more

information about the setup of counters, see Counters.

10. You can also select the attribute types that should be related to the asset type. On the Attr ibute typesAttr ibute types

FastTab, make your selections by using the methods that are described for maintenance job types in step
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NOTENOTE

Create asset type setup lines

NOTENOTE

8. Then, to create the preferred sequence of attribute types, select an attribute type in the Attr ibuteAttr ibute

types selectedtypes selected field, and use the up arrow and down arrow buttons to move it. The sequence of

attribute types will be shown on assets that use this asset type. For more information about asset

attributes, see Maintenance attribute types.

When you add new attribute types on the Attribute typesAttribute types FastTab, existing assets are automatically updated

with that information.

11. You can also select the condition assessment templates that should be related to the asset type. On the

Condition assessmentsCondition assessments  FastTab, make your selections by using the methods that are described for

maintenance job types in step 8. For more information about condition assessment templates and

registrations, see Condition assessment.

12. The Asset modelAsset model  FastTab shows all the combinations of asset manufacturers and models that are set up

on the selected asset type. To see the combinations divided according to manufacturer, select AssetAsset

modelmodel  to open the Asset modelAsset model  page.

On the Asset modelAsset model  page, you can add asset model–asset type relations. Additionally, on the AssetAsset

typestypes  page, you can add asset manufacturer–asset model relations directly to an asset type. Finally, on

the Asset modelAsset model  page (Asset managementAsset management > SetupSetup > AssetsAssets  > Asset modelAsset model ), you can create new

asset manufacturer–asset model–asset type relations. Therefore, there are three ways to set up and edit

asset manufacturer–asset model–asset type relations. All the available combinations are shown from

different perspectives, and you can select your preferred point of entry when you work with the setup.

If you select counters on an asset type, the selections are automatically updated on the CountersCounters  page (AssetAsset

managementmanagement  > SetupSetup > AssetsAssets  > Asset typesAsset types > CountersCounters).

The fields in the DetailsDetails  section on the GeneralGeneral FastTab show the number of maintenance job types, counters,

attributes, and so on, that are set up on the selected asset type.

Typically, work orders that are manually created are related to corrective maintenance, whereas work orders that

are automatically created are related to preventive maintenance. When you manually create work orders, only

the maintenance job types that are selected on the maintenance job typesmaintenance job types  FastTab of the Asset typesAsset types  page

can be used. However, automatically created work orders can use all the maintenance job types you create on

the Maintenance job typesMaintenance job types  page (Asset managementAsset management > SetupSetup > JobsJobs  > Maintenance job typesMaintenance job types ).

NOTENOTE

1. Select Asset managementAsset management > SetupSetup > AssetsAssets  > Asset typesAsset types  > Asset type setupAsset type setup. Alternatively, select

Asset managementAsset management > SetupSetup > AssetsAssets  > Asset typesAsset types  > Asset typesAsset types , select an asset type, and then

select Asset type setupAsset type setup.

2. The first time that you use the Asset type setupAsset type setup page, you might find the Create combinationsCreate combinations  button

useful. You can use this button to quickly create all combinations of an asset model on an asset type.

Select Create combinationsCreate combinations , select the asset type to create combinations for, and then select OKOK.

If you won't use all the asset type setup combinations that were automatically created, you can delete a setup by

selecting it and then selecting DeleteDelete.
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3. Select NewNew  to manually create an asset type setup.

4. Depending on how specific the asset type setup should be, make selections in the Asset typeAsset type,

ManufacturerManufacturer , and ModelModel  fields.

5. If a warranty agreement is related to the asset type, select the agreement in the Vendor warrantyVendor warranty  and

Customer warrantyCustomer warranty  fields.

6. On the Spare par tsSpare par ts  FastTab, select AddAdd to add spare parts to the selected asset type setup.

7. To approve a spare part, select the spare part line, and then select ApproveApprove. You can select multiple lines

for approval.

8. To see whether a spare part is used somewhere else in Asset Management (for example, in relation to

assets and work orders), select the spare part line, and then select Item where usedItem where used to open the ItemItem

where usedwhere used page. To see all active spare parts in the list, select the ActiveActive check box. To see only

approved spare parts, select the ApprovedApproved check box.

9. On the Maintenance plansMaintenance plans  FastTab, select AddAdd to add maintenance plans to the selected asset type

setup.

10. To copy an asset type setup to another setup, you can use the Copy function. Select the asset type setup

to copy a setup to, select Copy setupCopy setup, and select the asset type setup to copy the setup from. The

settings of the various options determine how much information is included. When you've finished, select

OKOK to copy the setup.

If you have many spare part lines and maintenance plan lines that you will reuse, the Copy function lets you quickly and

easily set up data for many asset type setup combinations.

As was described in the "Create asset type setup lines" section, spare parts are set up on asset models on the

Asset type setupAsset type setup page. Therefore, when you open the Asset type setupAsset type setup page, you see only the spare parts

that are related to the selected combination of an asset type, asset manufacturer, and asset model. To see a list of

all spare part records, open the Spare par tsSpare par ts  page (Asset managementAsset management > Inquir iesInquir ies  > Spare par tsSpare par ts ).

On the Spare par tsSpare par ts  page, you can also create new spare parts for existing combinations of an asset type, asset

manufacturer, and asset model. You can decide whether you prefer to create spare part records on the AssetAsset

type setuptype setup page or the Spare par tsSpare par ts  page. The Asset type setupAsset type setup page provides an overview of data on the

selected combination of an asset type, asset manufacturer, and asset model, whereas the Spare par tsSpare par ts  page

provides a complete overview of all asset type setup lines. If the Spare par tsSpare par ts  page contains many records, the

Asset type setupAsset type setup page might give you a better overview.

To see whether the spare part on the selected line is used anywhere else in Asset Management (for example, in

relation to assets and work orders), select Item where usedItem where used to open Item where usedItem where used page.
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Create a condition assessment template

Create condition assessment registration on an asset

This topic explains how to create a condition assessment template and registration on an asset in Asset

Management. Condition assessment is performed at regular intervals, and the primary objective is to create and

maintain condition data on assets. Seen from a preventive maintenance perspective, it is important to monitor

key information such as current condition, and remaining life span. Furthermore, if you carry out condition

assessment at regular intervals, you will be able to monitor and compare conditions on the machinery in your

factory.

Condition assessment can be used to measure and monitor many conditions on your equipment. Example: You

could measure vibrations on your machinery. After you have registered vibration measurements in Asset

Management on various types of equipment, you can search for the latest registered assessment and view

vibration measurements.

Condition assessment is created on assets. You set up a condition assessment template on an asset type before

you carry out the condition assessment procedure. The reason for using templates for condition assessment is

to avoid variation of condition data on similar assets. The sequence for setting up and using condition

assessment in Asset Management is: First you set up the required condition assessment templates. Next, you

associate templates with asset types in the Asset typesAsset types  form. Finally, you can create condition assessment

registrations on an asset in the AssetAsset form.

1. Select Asset managementAsset management > SetupSetup > Asset typesAsset types  > Condition assessmentCondition assessment.

2. Select NewNew  to create a new template.

3. Insert and ID for the template in the TemplateTemplate field.

4. Insert a name for the template in the NameName field.

5. On the Condition assessment linesCondition assessment lines  FastFab, add the lines required for the condition assessment, including

selection of the appropriate condition type and measurement unit.

6. On the Asset typesAsset types  FastTab, add the asset types that should use the condition assessment template.

7. In the L inesLines  and Asset typesAsset types  fields in the DetailsDetails  group at the top of the screen, you will see the number of

assessment lines and asset types related to the selected condition assessment template.

1. Select Asset managementAsset management > CommonCommon > AssetsAssets  > All AssetsAll Assets .

2. In the list, select the asset for which you want to create a condition assessment registration.

3. On the GeneralGeneral  tab, click Condition assessmentCondition assessment.

4. Click NewNew  to make a new registration.

5. Select the date for the condition assessment in the DateDate field.

6. Select the name of the worker who carried out the assessment registration in the WorkerWorker  field.

7. In the L inesLines  field, you see the number of assessment lines set up on the condition assessment.

8. Select a template for the condition assessment in the TemplateTemplate field. The name of the template is

automatically inserted in the NameName field, and the related registration lines are inserted on the ConditionCondition

assessment linesassessment lines  FastTab.

9. You can insert notes relating to the selected condition assessment on the NotesNotes  FastTab.

10. For each condition assessment line, insert measurement data in the ValueValue field.
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11. You can insert a comment relating to the selected registration line on the Condition assessment linesCondition assessment lines

FastTab > CommentsComments  field. If you add a comment on a line, the CommentComment check box is automatically

selected.

After you have made a condition assessment registration on an asset, you can print a condition assessment

report.

You can also register condition assessment on a work order (Asset managementAsset management  > CommonCommon > Work ordersWork orders  > AllAll

Work ordersWork orders  > Condition assessmentCondition assessment  button.)
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Set up product-model relations
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Select a manufacturer and model on an object

This topic explains how to set up asset manufacturers and related models in Asset Management. Models can be

related to asset types.

NOTENOTE

1. Select Asset managementAsset management > SetupSetup > AssetsAssets  > Manufacturer and modelManufacturer and model .

2. Select NewNew  to create a new product.

3. In the ManufacturerManufacturer  field, enter a name for the asset manufacturer.

4. In the Descr iptionDescr iption field, enter a description.

5. On the ModelsModels  FastTab, select AddAdd to create an asset model that should be related to the asset

manufacturer.

6. In the ModelModel  field, enter a name for the asset model.

7. In the Descr iptionDescr iption field, enter a description.

8. In the Asset typeAsset type field, select the asset type that the manufacturer model should be related to.

You can also set up relations for asset types, manufacturers, and models in the Asset typesAsset types lookup. For more

information, see Asset types.

In the DetailsDetails  FastTab, the ModelsModels  field shows the number of asset models that are set up on the

selected asset manufacturer. The AssetsAssets  field shows the number of assets that are using the selected

manufacturer.

The AssetsAssets  field shows the number of objects that are using the manufacturer model.

An asset type can have no asset manufacturer model relations, it can be related to one asset manufacturer model, or it

can be related multiple asset manufacturer models. If an asset type is related to at least one manufacturer model, only the

combinations that are set up in the Manufacturer modelManufacturer model lookup can be selected on those Asset Management pages

where a combination of an asset type, manufacturer, and model can be set up. These pages include All assetsAll assets , AssetAsset

ser vice levelsser vice levels , Job type defaultsJob type defaults , and Maintenance budget linesMaintenance budget lines . If some asset types aren't related to any

manufacturer model, only those asset types, and manufacturer models that also have no relation to asset types, are

shown on the pages.

1. Select Asset managementAsset management > CommonCommon > AssetsAssets  > All assetsAll assets .

2. In the AssetAsset column, select the link for the asset. The DetailsDetails  page appears.

3. Select EditEdit.

4. On the GeneralGeneral  FastTab, select values in the ManufacturerManufacturer  and ModelModel  fields.
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Create counter types for asset counter registrations

The topic explains how to create counter types in Asset Management. Counter types are used to make counter

registrations on assets, for example, regarding number of production hours, or quantity produced on the asset.

Asset types are related to the counter types. This means that a counter can only be used on an asset if the

counter is set up on the asset type used on the asset.

Before you can make counter registrations on assets, you first create the counter types you want to use in

CountersCounters . Next, you can create counter registrations on assets in CountersCounters .

Counters can be used on maintenance plans. A maintenance plan line can be of type "Counter", for example,

relating to number of production hours or quantity produced.

A counter registration can be updated manually or automatically based on production hours or quantity

produced. A counter can be set up to use one of three update methods (selected in the UpdateUpdate field in

CountersCounters ):

Manual - you must manually register counter values.

Production hours - the counter is automatically updated based on number of production hours.

Production quantity - the counter is automatically updated based on number of quantity produced.

If quantity produced is used, all registered items are included in the counter registration, good quantity as well as error

quantity. It is always possible to make manual counter registrations, if required.

1. Select Asset managementAsset management > SetupSetup > Asset typesAsset types  > CountersCounters .

2. Select NewNew  to create a new counter type.

3. Insert an ID in the CounterCounter  field, and a counter name in the NameName field.

4. On the GeneralGeneral  FastTab, select a counter unit in the UnitUnit field.

5. In the UpdateUpdate field, select the update method to be used for the counter.

6. Select "Yes" on the Inherit counter valuesInherit counter values  toggle button if child assets in an asset structure should

automatically inherit counter registrations made on the parent asset.

7. In the Total aggregateTotal aggregate field, select the summation method to be used for a counter using this counter type.

"Sum" is the standard selection used to continuously add registered values to the total value. "Average" can

be used if a counter is set up to monitor a threshold, for example, regarding temperature, vibrations, or wear

and tear on an asset.

8. In the Deviation overDeviation over  field, insert the upper level in percent for validating if manual counter registrations

are within an expected range. The validation is based on a linear increase in existing counter registrations.

9. In the Deviation underDeviation under  field, insert the lower level in percent for validating if manual counter registrations

are within an expected range. The validation is based on a linear decrease in existing counter registrations.

10. In the TypeType field, select the type of message (information, warning, error) to be shown if deviations outside

the defined range occur when you make manual counter registrations.

11. On the Asset typesAsset types  FastTab, add the asset types that should be able to use the counter.

12. On the Related asset countersRelated asset counters  FastTab, add the counter that you want to be automatically updated when
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this counter is updated.

A related counter is automatically updated only if the related counter has the asset type, to which it is related, in the

counter setup. For example: You set up a counter for "Production hours" and add the asset type "Truck Engine". When that

counter is updated, a related counter "Oil" is also updated with the same counter values. The setup in CountersCounters  includes

the setup on "Hours". Also, on the "Oil" counter, the asset type "Truck Engine" should be added to the Asset typesAsset types

FastTab to ensure the counter relation. See the screenshots below for an example of the setup on the Hours and Oil

counters.

When asset types are added to a counter type in CountersCounters , that counter is automatically added to the asset

types on the CountersCounters  FastTab in Asset types.
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The Assets tab

The Work orders tab

In Asset Management, general parameters relating to assets, work orders, and work order scheduling must be

set up. This topic explains how to set them up. Select Asset managementAsset management > SetupSetup > Asset managementAsset management

parametersparameters  to open the page.

If you'd like to set up a system that includes demo data for testing Asset Management features, see Deploy a demo

environment for instructions.

The AssetsAssets  tab provides the following settings:

Default functional locationDefault functional location is the standard functional location, which is automatically selected on assets

when you create new assets.

In the Standard calendarStandard calendar  field, select a calendar to be used for calculating asset KPIs if no resource is

selected on an asset.

In the ViewView  field, select the standard view that is shown when you open Asset viewAsset view  (Asset managementAsset management

> CommonCommon > AssetsAssets  > Asset viewAsset view ).

Default request typeDefault request type is the standard maintenance request type, which is automatically selected when you

create a new request.

Forecasts on job types are stored on the project selected in the Forecast projectForecast project field. For each job type, a

new activity is automatically created on the forecast project. Forecasts on the job type are then saved on the

forecast project.

In the ModelModel  field, select the forecast model used on job type and work order forecasts.

The Work ordersWork orders  tab provides the following settings:

Default work order typeDefault work order type defines standard settings when creating a work order.

Preventive work order typePreventive work order type defines the work order type used when creating work orders from

maintenance plans. If this field is left blank, the work order type in the Default work order typeDefault work order type field is

used.

In the Related work order maskRelated work order mask field, you define the maximum number of work orders that can be related

to a work order. For example, ## allows you to have up to 99 work orders related. If you define a mask as

described here, related work orders will be numbered [work order ID of the work order to which a work

order is related] -01, -02, -03, and so on. If you do not define a mask in this field, a related work order will get

the next sequential work order ID.

Select YesYes  for Copy faultsCopy faults  if you want to automatically copy faults registered on work orders to related

maintenance requests.

In the LevelLevel  field, you define the functional location level that is automatically inserted on a work order if all

related work order jobs refer to the same functional location. If the work order jobs do not all relate to the

same functional location on the defined level, the Functional locationFunctional location field is left blank on the work order.

For example, if you insert the number "1" in this field, that is the top level in a functional location structure. If
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you insert the number "0" in this field, you have not defined a specific functional location level, only that all

work order jobs on a work order must be related to the same functional location for that functional location

to be added to the work order.

Journals used when posting consumption on a work order can be selected on the GeneralGeneral  FastTab in the

HourHour , ItemItem, and ExpenseExpense fields.

In the Product language sourceProduct language source field, select which language to use for product names in Asset

management reports. You can select the language set up on the company account, or the language set up for

the user currently logged in.

Select YesYes  for Real time updateReal time update if you want to automatically update changes to job type defaults,

maintenance plans, and maintenance rounds.

On the Categor yCategor y  FastTab, default categories relating to consumption on work orders can be defined.

If you select NoNo, changes to job type defaults, maintenance plans, and maintenance rounds are not

updated automatically in Asset Management.

Select NoNo if you have large amounts of data being synchronized, for example, many assets or

functional locations set up on maintenance plans or maintenance rounds, or a large number of

maintenance plans or rounds.

If you make changes to job type defaults or maintenance plans or maintenance rounds, and you have

selected NoNo to real time update, a warning may not be shown if the changes influence:

Functional locations set up on maintenance plans or rounds

Objects set up on maintenance plans or rounds

Maintenance plans setup

Maintenance rounds setup

The Work order schedulingWork order scheduling tab provides the following settings on the GeneralGeneral  FastTab:

Schedule time fenceSchedule time fence defines period in days, calculated from the expected start date of the work order,

during which work order jobs are planned.

The Master planMaster plan relates to resources in the Organization administrationOrganization administration module. If you select a master

plan in this field, you will be able to see capacity reservations related to work orders in CapacityCapacity

reser vationsreser vations  (Organization administrationOrganization administration > ResourcesResources  > ResourcesResources  > select resource > ResourceResource

tab > Capacity reser vationsCapacity reser vations  button). If you leave this field blank, you will be able to see capacity load

related to work orders in Capacity loadCapacity load (Organization administrationOrganization administration > ResourcesResources  > ResourcesResources  >

select resource > ResourceResource tab > Capacity loadCapacity load button).

The selection regarding using a master plan in the Asset managementAsset management  module, and the related form used to get an

overview of capacity reservations or capacity load is the standard setup. Depending on your setup in the Master planMaster plan

field, you will be able to access capacity information in either Capacity reser vationsCapacity reser vations or Capacity loadCapacity load in the

Organization administrationOrganization administration module. It is not possible to create a setup in which capacity reservations are shown in

both views.

The fields described in the following list all relate to calculated rating scores, which are used to calculate work

order priority during work order scheduling.

Pr ior ityPr ior ity  - A rating score calculated together with the rating score in the CriticalityCriticality  and Star t dateStar t date fields.

The number in this field is divided by the number in the Pr ior ityPr ior ity  field on a work order. For example, if the

value "5.00" is inserted in this field, and a work order has priority "20", the rating score for priority is 0.25.

Cr iticalityCriticality  - A rating score calculated together with the rating score in the Pr ior ityPr ior ity  and Star t dateStar t date fields.

The number in this field is multiplied by the number in the CriticalityCriticality  field on a work order. For example, if



the value "10.00" is inserted in this field, and a work order has criticality "5", the rating score for criticality is

50.

Star t dateStar t date - A rating score calculated together with the rating score in the Pr ior ityPr ior ity  and CriticalityCriticality  fields.

This field indicates daily score as a negative value and is compared to the Expected star tExpected star t field on a work

order. For example, if the value "10.00" is inserted in this field, and the expected start date of a work order is

three days from now, the rating result is minus 30.00. Adding the results of 0.25 and 50 from the examples in

the Pr ior ityPr ior ity  and CriticalityCriticality  fields described above provides a total of plus 20.25. That number is compared

to all other work order rating scores during work order scheduling, and the highest rating scores are then

planned first.

Responsible workerResponsible worker  - A rating score calculated together with the Responsible worker groupResponsible worker group, PreferredPreferred

workerworker , Preferred worker groupPreferred worker group, Asset locationAsset location, and Star t dateStar t date rating score values. If the value "50.00"

is inserted in this field, and a responsible worker has been selected on a work order, the worker gets 50

points in the overall worker calculation during work order scheduling.

Responsible worker groupResponsible worker group - A rating score calculated together with the Responsible workerResponsible worker , PreferredPreferred

workerworker , Preferred worker groupPreferred worker group, Asset locationAsset location, and Star t dateStar t date rating score values. If the value "50.00"

is inserted in this field, and a responsible worker has been selected on a work order, the worker gets 50

points in the overall worker calculation during work order scheduling.

L imit to responsibleLimit to responsible - This limits the number of workers available for work order scheduling. Select NoNo if

you want to calculate a score for all workers, regardless if they are set up as responsible workers or part of a

responsible worker group. Select YesYes  if you want to calculate a score for workers who are set up as

responsible worker on the work order, and/or included in a responsible worker group selected on the work

order.

Preferred workerPreferred worker  - A rating score calculated together with the Responsible workerResponsible worker , Preferred workerPreferred worker ,

Preferred worker groupPreferred worker group, Asset locationAsset location, and Star t dateStar t date rating score values. The four rating scores are

calculated and added together to provide a score used for selecting which worker should be assigned to

which work order during work order scheduling. If the value "10.00" is inserted in this field, and a worker has

been selected as preferred worker on a work order, that worker gets 10 points in the overall worker

calculation during work order scheduling.

Preferred worker groupPreferred worker group - A rating score calculated together with the Responsible workerResponsible worker , PreferredPreferred

workerworker , Preferred worker groupPreferred worker group, Asset locationAsset location, and Star t dateStar t date rating score values. If the value "10.00"

is inserted in this field, and a worker has been assigned to a preferred worker group selected on a work

order, that worker gets 10 points in the overall worker calculation during work order scheduling.

L imit to preferredLimit to preferred - This limits the number of workers available for work order scheduling. Select NoNo if

you want to calculate a score for all workers, whether they are set up as preferred workers or part of a

preferred worker group. Select YesYes  if you only want to calculate a score for workers who are set up as

preferred workers, and/or included in a preferred worker group.

LocationLocation - A rating score calculated together with the Responsible workerResponsible worker , Preferred workerPreferred worker , PreferredPreferred

worker groupworker group, Asset locationAsset location, and Star t dateStar t date rating score values. If the value "3,000.00" is inserted in this

field, a worker gets 3,000 points in the calculation if the worker is located in the same factory or facility as the

asset on which a job is to be scheduled.

L imit to locationLimit to location - This limits the number of workers available for work order scheduling. Select NoNo if you

want to calculate a score for all workers across all functional locations. Select YesYes  if you only want to

If your company uses functional locations, workers get full score if they are located on the functional

location related to the asset. If the functional location of the asset has a parent asset, workers on that

functional location get 1/2 score. If that location also has a parent, workers on that location get 1/3

score. If that location also has a parent, workers on that location get 1/4 score, and so on.

If your company uses asset location, which we do not recommend, location, area, and zone are used to

calculate location scores. Workers get full score if they are located in the location and area and zone

related to the asset. If worker location only matches location and area, the rating score for the worker

is 2/3 of the full score. If worker location only matches location, the rating score for the worker is 1/3

of the full score.
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calculate a score for workers who are associated with the work order's functional location.

The three "Limit to" fields increase the speed of work order scheduling by limiting the number of scores calculated for

workers.

Worker's star t dateWorker 's star t date - A rating score calculated together with the Responsible workerResponsible worker , Preferred workerPreferred worker ,

Preferred worker groupPreferred worker group, Asset locationAsset location, and Star t dateStar t date rating score values. This field indicates daily score

as a negative value and is compared to the Expected star tExpected star t field on a work order. If the value "10.00" is inserted

in this field, and the expected start date of a work order is tomorrow, the rating result is minus 10.00.

Assuming that no responsible worker and responsible worker group have been selected on a work order to

be scheduled - you add and subtract the rating score values in the examples in the Preferred workerPreferred worker ,

Preferred worker groupPreferred worker group, Asset locationAsset location, and Star t dateStar t date fields above, you get a total of 3,010.00. This

means a high score for the worker who is already selected as preferred worker as well as included in the

preferred worker group on the work order, and the worker is also located in the same facility as the asset for

which a job needs to be scheduled. This means there is a good chance that the worker in question will be

selected to complete the job during work order scheduling.

If the value "0.00" is inserted in one of the eight fields above, that rating score will not be used during work

order scheduling.

Select the document types that should be available for printing attachments related to a work order report. This

is done by selecting a document type in the AvailableAvailable section and selecting . If you want to remove a selected

document type, select the document type in the SelectedSelected section and select .

Select the required number sequences in this section. There are two number sequences for assets: one for

manually created assets and one for assets created through pending assets.

Can you tell us about your documentation language preferences? Take a short survey.
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https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Asset lifecycle states
2/18/2021 • 3 minutes to read • Edit Online

NOTENOTE

NOTENOTE

This topic explains asset lifecycle states and lifecycle models in Asset Management. Asset lifecycle states are

used to define whether an asset is active or inactive. For example, you can set up asset lifecycle states such as

CreatedCreated, ActiveActive, and TerminatedTerminated.

Request lifecycle states are linked to asset lifecycle states. Therefore, when a request is changed to a new request

lifecycle state, the asset that is attached to the request is changed to a new asset lifecycle state. For example, if the

lifecycle state of a request is changed to InboundInbound, the lifecycle state of the attached asset is changed to the lifecycle

state that is selected in the Inbound lifecycle stateInbound lifecycle state field on the Asset lifecycle stateAsset lifecycle state FastTab of the AssetAsset

lifecycle state modelslifecycle state models  page.

Asset lifecycle states can be set up in asset lifecycle models, where you can define the required lifecycle states

for various types of assets. You first set up lifecycle states. You then create a lifecycle model and select lifecycle

states for it.

1. Select Asset managementAsset management > SetupSetup > AssetsAssets  > L ifecycle statesLifecycle states .

2. Select NewNew  to create a new asset lifecycle state.

3. In the L ifecycle stateLifecycle state field, enter the lifecycle state ID.

4. In the NameName field, enter a description.

The L ifecycle modelsL ifecycle models  field shows the number of asset lifecycle models that use the asset lifecycle state.

5. Set the ActiveActive option to YesYes  if this lifecycle state should be an active lifecycle state (in other words, if

work orders can be created for assets that are in this lifecycle state).

6. Set the Delete open calendar linesDelete open calendar lines  option to YesYes  if open asset calendar lines that have an asset

lifecycle state of CreatedCreated should be deleted when they are in this lifecycle state. This setting is useful if

you want to clean up any open maintenance schedules that are no longer relevant for the asset (for

example, if the asset is no longer active).

Asset lifecycle states, asset lifecycle models, and asset types are related. They are used in the same way as work order

lifecycle states, work order lifecycle models, and work order types.

After you've created the required asset lifecycle states, you can set up lifecycle states in asset lifecycle models.

1. Select Asset managementAsset management > SetupSetup > assetsassets  > lifecycle modelslifecycle models .

2. Select NewNew  to create a new asset lifecycle model.

3. In the L ifecycle modelL ifecycle model  field, enter the lifecycle model ID.

4. In the NameName field, enter a description.

The L ifecycle statesLifecycle states  field shows the number of asset lifecycle states that are selected in the asset

lifecycle model. The Asset typesAsset types  field shows the number of asset types that use the lifecycle model.
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5. On the L ifecycle statesLifecycle states  FastTab, select the asset lifecycle states that should be included in the asset

lifecycle model:

To use a lifecycle state for the model, select it in the L ifecycle states remainingLifecycle states remaining section, and then

select the right arrow button  to move it to the L ifecycle states selectedLifecycle states selected section.

To use all the available lifecycle states for the model, select the All available lifecycle statesAll available lifecycle states  button 

. All lifecycle states are transferred to the L ifecycle states selectedLifecycle states selected section.

To remove a lifecycle state from the model, select it in the lifecycle states selectedlifecycle states selected section, and then

select the left arrow button  to move it to the L ifecycle states remainingLifecycle states remaining section.

6. Select L ifecycle state updatesLifecycle state updates  to define the asset lifecycle states that can follow a selected lifecycle

state.

7. You use the Asset stateAsset state FastTab if you handle assets that you receive for repair. In the

Inbound/outboundInbound/outbound section, you can select asset lifecycle states to indicate the workflow of an asset that

you receive for repair. If you offer loan assets to customers or departments, in the LoanLoan section, you can

select lifecycle states for loan assets.
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Set up asset service levels

NOTENOTE

NOTENOTE

This topic explains asset service levels in Asset Management. Asset service levels are related to assets, and are

transferred to maintenance requests and work orders. They are used to calculate the priority of work orders

during work order scheduling. Asset service levels can be changed, if changes are required.

For more information about the setup that is related to the calculation of rating scores for work order

scheduling, see Asset Management parameters. You must set up at least one default record for the asset service

level. This default record is used if no other match is found during work order scheduling.

Example 1:Example 1: The default service level that is used if no other match is found. In this record, you select only a

service level.

Example 2:Example 2: A high service level that is used to schedule jobs for a Volvo truck engine. In this record, you select

a relevant asset type (such as Truck EngineTruck Engine), a manufacturer (VolvoVolvo), and a service level.

NOTENOTE

1. Select Asset managementAsset management > SetupSetup > Asset ser vice levelsAsset ser vice levels .

2. Select NewNew  to create a record.

3. Depending on the detail level that is required for the asset service level, make relevant selections in the

Functional locationFunctional location, Asset typeAsset type, ManufacturerManufacturer , ModelModel , AssetAsset, Work order typeWork order type, and Ser viceSer vice

levellevel  fields.

When the asset service level is used for maintenance requests and work orders, Asset Management goes through

all asset service level records to check for a possible match. It always checks the most specific combination first. In

other words, Asset Management first checks for a match for the Work order typeWork order type field. If no match is found, it

checks for a match for the AssetAsset  field, and so on. As you can see in the layout of the Asset ser vice levelsAsset ser vice levels  page,

this behavior means that, to find the most specific combination, Asset Management checks each record from right

to left for a match. If no match is found, the default record that has no selections in those fields is used.

4. In the Ser vice levelSer vice level  field, select a number that indicates the service level (priority).

If you change an asset service level record on the Asset ser vice levelsAsset ser vice levels  page after you've already used it on a work

order, the service level on maintenance requests and work orders isn't updated accordingly.
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Set up criticality types

Set up asset criticalities

The topic explains asset criticality types in Asset Management. Asset criticality is related to assets and is

transferred to work orders. It can't be changed on a work order. Asset criticality is used to calculate work order

criticality during work order scheduling. In other words, it's used to calculate the extent to which a maintenance

job on an asset affects the production schedule and productivity in your company. For more information about

the setup that is related to the calculation of rating scores for work order scheduling, see Asset Management

parameters.

To set up criticality, you first create the criticality types that should be used in the asset setup. You then set up

asset criticalities.

1. Select Asset managementAsset management > SetupSetup > AssetsAssets  > Criticality typesCriticality types .

2. Select NewNew  to create a record.

3. In the CriticalityCriticality  field, enter a number that indicates the criticality.

4. In the NameName field, enter a name for the criticality type.

5. In the FactorFactor  field, enter a factor. This factor is used during the calculation of work order scheduling to

determine the criticality record that should be used. (The record that has the highest factor is always

used.) This setting is relevant if, as shown in the following illustration, criticality lines are created that have

the same criticality value.
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NOTENOTE

NOTENOTE

1. Select Asset managementAsset management > SetupSetup > Asset cr iticalitiesAsset cr iticalities .

2. Select NewNew  to create a record.

3. Depending on the required level of detail for asset criticality, make relevant selections in the FunctionalFunctional

locationlocation, Asset typeAsset type, ManufacturerManufacturer , ModelModel , AssetAsset, Job type categor yJob type categor y , Job typeJob type, Job type var iantJob type var iant,

and Job requirementJob requirement fields.

When an asset criticality is selected, Asset Management goes through all asset criticality records to check for a

possible match. It always checks the most specific combination first. In other words, Asset Management first

checks Job requirementJob requirement . If no match is found, it checks Job type variantJob type variant . If no match is found, it checks JobJob

typetype, and so on. As you can see in the layout of the page, this behavior means that, to find the most specific

combination, Asset Management checks each record from right to left for a match. If no match is found, the

"default" record that has no selections is used.

4. In the CriticalityCriticality  field, select one of the criticality values that you created in the previous procedure.

If you change an asset criticality in this setup after you've already used it on a work order, the criticality on the

work order isn't updated accordingly.

The criticality on a work order is recalculated every time that a work order line is added to or deleted from

the work order.

If a work order contains several work order jobs, the highest criticality, according to the FactorFactor  field on the

Criticality typesCriticality types  page, is always used on the work order.

Generally, asset criticality can change over a period. Criticality can be affected by the purchase of new

equipment, refurbishments, and so on. Consider reevaluating your asset criticalities at regular intervals (for

example, once per year or every other year) to make sure that your criticality definitions match your current

production setup.
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Create asset document relation

NOTENOTE

This topic explains asset documents in Asset Management.

In Asset Management, you can set up documents so that they are automatically related to job types, asset

manufacturers, asset types, or assets, for example. This functionality is useful when updated document versions

are released. In that case, you just have to put the updated document in the standard location that you use for

your Supply Chain Management documents, and attach the document to the asset document record that you've

created. The updated document can then be accessed from the All assetsAll assets , Active assetsActive assets , My active assetsMy active assets ,

All work ordersAll work orders , and Active work order jobsActive work order jobs  menu items. The process for attaching documents to an asset

document record uses the standard document handling system.

Example 1:Example 1: A document that is related to a job type might describe a procedure for that job type.

Example 2:Example 2: A document that is related to a combination of an asset type, manufacturer, and model might be the

standard manual for the selected asset manufacturer model.

NOTENOTE

1. Select Asset managementAsset management > SetupSetup > Asset documentsAsset documents .

2. Select NewNew  to create an asset document record.

3. Depending on how specific you want the document relation to be, make relevant selections in one or

more of the following fields: Asset typeAsset type, ManufacturerManufacturer , ModelModel , AssetAsset, Job type categor yJob type categor y , Job typeJob type,

Job type var iantJob type var iant, and Job requirementJob requirement. The options that are available in the Job type var iantJob type var iant and

Job requirementJob requirement fields depend on your selection in the Job typeJob type field.

When the system searches for documents that should be related to an asset or a work order, Asset Management

goes through all asset document records to check for a possible match. It always checks the most specific

combination first. In other words, Asset Management first checks for a match for the Job requirementJob requirement  field. If

no match is found, it checks for a match for the Job type variantJob type variant  field. If no match is found, it checks for a

match for the Job typeJob type field, and so on. As you can see in the layout of the Asset documentsAsset documents page, this

behavior means that, to find the most specific combination, Asset Management checks each record from right to

left for a match. Several documents might be related to an asset or a work order. You can edit the service level on

a maintenance request or a work order as you require.

4. Select AttachmentsAttachments . The standard Document handlingDocument handling page appears.

5. Set up the documents or notes that should be attached to the asset document record. After you attach

documents, the AttachmentsAttachments  field shows the number of documents that are related to the record.
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Create workers

Create worker groups

This topic explains maintenance workers and worker groups in Asset Management. In Asset Management, you

can connect maintenance workers to functional locations. (For more information about functional locations, see

Create functional locations.) This functionality might be useful if, for example, you're scheduling a maintenance

job on a machine that is located in functional location 01, and you want to allocate maintenance workers from

the same location to perform the job.

You can also create maintenance worker groups and associate maintenance workers with them. This

functionality is useful when you do simple work order scheduling, and you want to schedule a group of

maintenance workers on a work order. You can use maintenance workers and maintenance worker groups to set

up preferred maintenance workers and responsible maintenance workers.

NOTENOTE

1. Select Asset managementAsset management > SetupSetup > WorkersWorkers  > WorkersWorkers .

2. Select NewNew  to add a worker to the list.

3. In the WorkerWorker  field, select the worker.

4. Set the ActiveActive option to YesYes  to schedule the worker on work orders.

On the GeneralGeneral  FastTab, the ResourceResource and Descr iptionDescr iption fields are automatically filled in if a resource

has been selected for the worker. The CalendarCalendar  field is also automatically filled in, provided that you've

set up the worker as a resource and allocated a calendar to that resource on the ResourcesResources  page

(Organization administrationOrganization administration > ResourcesResources  > ResourcesResources ).

5. On the GroupsGroups  FastTab, select AddAdd, and then select a maintenance worker group for the worker. A

worker can be affiliated with more than one group.

6. In the standard setup, a worker's affiliation with a group is effective from the date when you add the

group, and it never expires. This date is shown in the EffectiveEffective field. To see the EffectiveEffective field, select

ViewView  > AllAll . If the worker's affiliation with a group should be limited to a specific period, use the

EffectiveEffective and ExpirationExpiration fields to define the period.

7. On the Functional locationsFunctional locations  FastTab, select AddAdd, and then select a functional location for the

maintenance worker. Also specify which location is the primary functional location for the worker.

When you add functional locations to a worker, all active assets that are related to those functional locations

appear on various menu items, such as My active assetsMy active assets  and My active functional locationsMy active functional locations . They also

appear in the asset lookups that are shown when you create a new asset, maintenance request, or work order.

The fields on the DetailsDetails  FastTab show the number of maintenance worker groups and functional

locations that the selected maintenance worker is related to.

1. Select Asset managementAsset management > SetupSetup > WorkersWorkers  > Maintenance worker groupsMaintenance worker groups .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/setup-for-objects/workers-and-worker-groups.md


NOTENOTE

2. Select NewNew  to add a worker group to the list.

3. In the Maintenance worker groupMaintenance worker group field, enter a group ID.

4. In the NameName field, enter a name.

5. On the WorkersWorkers  FastTab, select AddAdd, and then select a maintenance worker for the worker group. For

information about the EffectiveEffective and ExpirationExpiration fields, see step 6 in the previous procedure.

6. If a resource group should be related to the selected maintenance worker group, select Copy fromCopy from

resource groupresource group. In the GroupGroup field, select the resource group to copy calendar settings from. Then, in

the Worker groupWorker group field, select the worker group to copy the resource group's calendar settings to. This

step is relevant only if you want maintenance workers to use the calendar that is related to a resource

(work center) during work order scheduling.

The field on the DetailsDetails  FastTab shows the number of maintenance workers that have been set up on the

selected maintenance worker group.
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All assets
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Edit Edit the selected asset.

New Create a new asset.

Delete Delete the selected asset.

Move asset Move assets to another asset structure, or to another
location in the same asset structure.

Replace asset Replace one child asset in an asset hierarchy with another
asset.

Install asset Install an asset on a functional location.

Copy asset Copy an asset hierarchy to another asset.

Requests Open the Active requestsActive requests  list page, where you can view
maintenance requests that have been created for the
selected asset.

This topic provides an overview of assets in Asset Management. An asset is any type of equipment, such as a

machine or a machine part, that requires maintenance, service, or repair.

An asset is automatically updated with related information. For example, this related information might be about

new or updated work orders. You can create assets by using either the All assetsAll assets  menu item or the PendingPending

assetsassets  menu item. This topic explains how to create assets by using the All assetsAll assets  menu item. For information

about how to create assets by using the Pending assetsPending assets  menu item, see Create assets based on purchase

orders.

Select Asset managementAsset management > CommonCommon > AssetsAssets  > All assetsAll assets . The All assetsAll assets  list page shows all assets and

some of the information that is related to them. To view only active assets, select Active assetsActive assets . To view only

assets that are installed on the functional locations that you're related to as a maintenance worker, select MyMy

active assetsactive assets . (This relation is set up on the WorkersWorkers  page. For more information, see Maintenance workers

and worker groups.)

In the All assetsAll assets  grid view, select a link in the AssetAsset column to view the details of the selected record. To edit

the record, select the EditEdit button. The details view shows detailed information that is related to the asset. A

Related informationRelated information pane on the right contains additional asset-related information. Expand the pane to show

the related information for the selected asset.

The buttons on the Action Pane are organized on tabs. The following table briefly describes the buttons that are

related to Asset Management.
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Event history View an overview of the various registrations that have been
made on the asset.

Asset BOM View a list of all items (spare parts and other items) that are
used on an asset.

Work orders Open the Active work ordersActive work orders  list page, where you can
view work orders for the asset.

Checklist View an overview of maintenance checklists and
measurements that have been registered on the asset.

Maintenance downtime Create or view maintenance downtime registrations on the
asset.

Project transactions View all posted transactions that are related to work orders
that have been created for the asset.

Asset measures Create or view asset measures on the asset.

Maintenance schedule Open the Open maintenance scheduleOpen maintenance schedule list page, where
you can view maintenance plans, maintenance requests, and
maintenance rounds that are associated with the asset, and
that have a status of CreatedCreated.

Update asset state Update the asset lifecycle state. You can select multiple
assets on the All assetsAll assets  list page and then update the asset
lifecycle state for all of them at the same time.

Lifecycle state log Open a log that shows the lifecycle states of the selected
asset.

Asset documents View a list of the documents that are attached to an asset.
These documents are set up at Asset managementAsset management  >
SetupSetup > Asset documentsAsset documents .

Attributes Create or view asset attributes.

Image Select an image for the asset.

Parent assets View parent asset history for the selected asset.

Functional locations View functional location history for the selected asset.

Condition assessment Register condition assessment measurements on the asset.

Faults Open the Asset faultsAsset faults  list page, where you can view faults
that have been registered on the asset.

Cost control Compare budget costs and actual costs on the asset.

Hour control Compare forecast hours and actual hours on the asset.
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Asset KPIs Calculate and view key performance indicators (KPIs) for the
asset.

Job types View an overview of the current default job types for the
asset.

Criticality types View or update asset criticality types.

Spare parts View a list of approved and alternative spare parts that can
be used on the asset.

Asset consumption Print a report that shows consumption registrations on the
asset.

Asset fault Print a report that shows fault registrations on the asset.
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General information

This topic describes how to create an asset in Asset Management.

NOTENOTE

NOTENOTE

1. Click Asset managementAsset management > CommonCommon > assetsassets  > All assetsAll assets  or Active assetsActive assets .

2. Click the NewNew  button.

3. In the Create assetsCreate assets  dialog, insert data regarding AssetAsset (the asset ID) and the asset name. Select date

and time for the asset in the EffectiveEffective field. From that date, you are able to install the asset on a

functional location as well as move and replace the asset in an asset structure.

4. In the Asset typeAsset type field, select the asset type for the asset (mandatory field). If required, select AssetAsset

manufacturermanufacturer  and Asset modelAsset model  for the asset. If only one product has been set up, that product is

automatically selected in the Asset manufacturerAsset manufacturer  field. The selections available in the AssetAsset

manufacturermanufacturer  and Asset modelAsset model  fields depend on the setup in Asset manufacturers and models.

5. In the Parent assetParent asset group, the AssetAsset field is blank as default. If required, you can select a parent asset,

and then all fields in the Parent assetParent asset group will automatically be filled out.

When you select a parent asset, two or three tabs are available: The My assetsMy assets  tab contains assets related to the

functional locations to which you (the maintenance worker who is logged on the system) may be allocated. If no

functional locations are set up on a maintenance worker in the Maintenance workers and worker groups form, the

My assetsMy assets  tab will not be visible. The Active assetsActive assets  tab contains a list of all assets with asset lifecycle state

"Active". The Asset viewAsset view tab displays a tree view of functional locations and assets installed on those locations.

6. The default functional location you have set up is suggested for the asset in the AssetAsset group >

Functional locationFunctional location field. Select another functional location, if required.

After you have created an asset, you can install it on another functional location, if required. Only top-level assets

(assets without a current parent asset) can be installed on a functional location. This means that you install the top

level as well as any child assets on the selected functional location. Read more about installing assets on functional

locations in Introduction to functional locations.

7. Click OKOK.

8. Select the asset in the All AssetsAll Assets  list and click the EditEdit button to add further information to the asset.

The functional location to which the asset is related is shown in the Functional locationFunctional location field. If the asset is a

parent asset, the number of children related to the asset is shown in the ChildrenChildren field. If the asset is a sub asset

to an existing asset, the ID of the parent asset is shown in the ParentParent field.

You can edit Asset manufacturerAsset manufacturer  and Asset modelAsset model  information on the asset, which is used to manage spare

parts, alternative spare parts, and job type defaults. Refer to Asset manufacturers and models for more

information. You can also add information about Model yearModel year  and Serial numberSerial number , if required.
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Asset

Details

Notes

Attributes

Current lifecycle stateCurrent lifecycle state is used to define if the asset is active or inactive. When creating an asset, the stage is

always set to the first stage in the asset stage group. When you are ready to activate an asset, click UpdateUpdate

asset stateasset state, and select the lifecycle state that you have defined as "asset active", and click OKOK.

Note:Note: When an asset is set to "inactive", it is no longer possible to create work orders for the asset. Also, you

cannot schedule preventive maintenance jobs for an inactive asset.

The Ser vice levelSer vice level  and CriticalityCriticality  fields relate to work orders created for the asset. The fields show the Ser viceSer vice

levellevel  and CriticalityCriticality  numbers calculated for the current setup for the asset. Refer to Asset service levels and

Asset criticality types regarding setup of those values.

You can select a ResourceResource for the asset. The resource selection determines which calendar is used for work

order scheduling. Resource selection is often used for fixed assets. Resources and resource groups are set up in

Organization administrationOrganization administration > ResourcesResources  > Resource groupsResource groups  or ResourcesResources .

In the Fixed assets numberFixed assets number  field, you can select a fixed asset to be related to the asset. This is relevant if your

asset is related to an investment project.

If the asset is related to a fixed asset, you can create a work order type to be used for work orders related to

an investment project.

Information about fixed assets for an asset is related to the Fixed assetsFixed assets  module in Dynamics 365 Supply

Chain Management. This means that in Fixed assetsFixed assets  > Fixed assetsFixed assets  > Fixed assetsFixed assets , you can get an

overview of the Asset Management projects that may be related to a fixed asset by selecting the asset in the

list and viewing the contents in the Related informationRelated information pane > Associated projectsAssociated projects  section.

In the Active fromActive from field, the date on which you updated the asset lifecycle state to an active state (refer to Asset

lifecycle states regarding setup of asset lifecycle states), is shown. If the asset is no longer active, and you have

updated the asset lifecycle state to an inactive lifecycle state, the date from which the asset is inactive is shown in

the Active toActive to field. If required, you can manually change those dates.

If required, you can insert an expected date for replacement of the asset in the Replacement dateReplacement date field. An

estimated value for replacing the asset can be inserted in the Replacement valueReplacement value field. Example: You can use

replacement information to compare it with the costs of maintaining an asset, and subsequently make a

decision for purchasing a new asset if maintenance costs on the existing asset increase rapidly.

You can add notes related to the asset on the NotesNotes  FastTab. Click the Add timestampAdd timestamp button before you write

the note, if you want to add user information and a date/timestamp to the note.

On this FastTab, you can set values for asset attributes. These attributes can be used to describe properties or

characteristics pertinent to the asset, for example, size, weight, or machine configuration.

Click Add lineAdd line and select the attribute type. Next, insert the ValueValue related to the attribute type and save the

record.



NOTENOTE

Vendor

Address

Asset management plans

NOTENOTE

Functional location maintenance plans

Maintenance rounds

Financial dimensions

NOTENOTE

You can get an overview of asset attribute types and their relation to the assets in Asset attributeAsset attribute and Asset attributeAsset attribute

over viewover view. Refer to Asset attribute overview for more information.

On the VendorVendor  FastTab, select a vendor account for the asset. Also, if a vendor warranty has been granted, you

can insert warranty information here.

On the AddressAddress  FastTab, you can insert the address of the equipment. If no address is inserted on the asset, the

asset uses the address of a parent asset, if the parent asset has an address. If no address is related to the asset or

any parents in the asset hierarchy, the address of the functional location on which the asset is installed may be

used. If that functional location does not have an address related to it, the address of the parent functional

location is used on the asset.

Maintenance plans are used for scheduling preventive maintenance jobs at regular intervals on the asset. On

this FastTab, you can set up maintenance plan lines for the selected asset. Maintenance rounds can be set up for

various assets, on which you need to carry out a similar task at regular intervals. On the Functional locationFunctional location

maintenance plansmaintenance plans  tab, you see the maintenance plans related to the functional location on which the asset is

installed.

If you delete a maintenance plan line or a maintenance round related to an asset in All AssetAll Asset , you also automatically

delete all maintenance schedules with status "Created" that have been created based on that maintenance plan or

maintenance round.

On this FastTab, you get an overview of the maintenance plans related to the functional location on which the

asset is installed.

On this FastTab, you can add or remove maintenance rounds, which are related to the asset.

You can select financial dimensions for the asset.
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Copy an asset or asset structure

NOTENOTE

Delete an asset or asset structure

This topic explains how to create and delete multi-level assets. You can create assets and related sub-assets in a

hierarchical tree structure. In this way, you can show relations and dependencies among assets. Maintenance

jobs can be related to all levels of the tree structure. Statistics can also be created for an individual level or as a

sum of all sub-asset levels.

On the All AssetsAll Assets  list page (Asset managementAsset management > CommonCommon > AssetsAssets  > All assetsAll assets ), the AssetAsset column lists

assets in hierarchical order. The ParentParent column shows the related parent. Additionally, if assets and sub-assets

have already been created, the Asset treeAsset tree section in the Related informationRelated information pane shows the assets in a tree

structure.

For information about how to create an asset, see Create an asset. To create a sub-asset, select the parent asset

in the ParentParent field on the GeneralGeneral  FastTab.

If your company has several similar asset structures, you can use the Copy function in Asset Management to

quickly create them.

1. Select Asset managementAsset management > CommonCommon > AssetsAssets  > All assetsAll assets .

2. On the All assetsAll assets  list page, select the asset to copy. For example, if you want to copy the whole asset

structure, including sub-assets, select a parent asset.

3. Select Copy assetCopy asset. In the Copy fromCopy from section, the AssetAsset field is set to the asset that you selected on the list

page.

4. In the Copy toCopy to section, in the AssetAsset field, enter the name of the new asset.

5. If the asset that you're creating should be part of an existing asset structure, in the Parent assetParent asset section, in

the AssetAsset field, select a parent ID.

6. Select OKOK. The new asset structure is shown on the All assetsAll assets  list page. All asset attributes, maintenance

plans, and maintenance rounds that are related to the asset that you copied are transferred to the new asset

or asset structure.

When you copy an asset structure, the sub-assets in the new structure have the same name as the sub-assets

that you copied. After the copy procedure is completed, you can easily change the name and other settings for

an asset. Select the asset on the All assetsAll assets  list page, and then select the EditEdit button.

When you copy an asset or asset structure, the lifecycle state of the new assets is reset to whatever state you defined as

the initial lifecycle state for assets. The functional location is reset to the default functional location.

If an asset has related sub-assets, you can delete it only if no maintenance requests, work order jobs, fault

registrations, or condition assessments are registered on any of the assets.

1. On the All assetsAll assets  list page, select the asset to delete.

2. Select DeleteDelete.
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If you can't delete an asset by using this procedure, another way to handle deletion is to set up an asset lifecycle state for

this purpose. For example, you can set up a ScrappedScrapped or DeletedDeleted lifecycle state on the Asset lifecycle statesAsset lifecycle states page.
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Move asset

NOTENOTE

Replace asset

This topic explains how to move, replace, and install assets in Asset Management. You can create individual

assets that have no relations to other assets, or you can create an asset structure that includes a parent asset

(top-level asset) and related child assets (sub-assets). In Asset Management, there are three approaches to

moving and changing the location of an asset:

MoveMove – Move an asset either to another asset structure or to another location in the same asset structure.

ReplaceReplace – Temporarily remove an asset from an asset structure so that it can be repaired or refurbished, and

then add the refurbished asset back to the asset structure later. Alternatively, permanently replace a used

asset with a new asset.

InstallInstall  – Install a parent asset and any related child assets on a functional location.

The asset that you move, replace, or install might be related to another functional location. In that case, the asset might

use financial dimensions of the functional location. On the Functional location typesFunctional location types page, you set up the handling of

financial dimensions on functional locations.

Use the Move assetMove asset function to move an asset either to another asset structure or to another location in the

same asset structure. You can also move an asset out of an asset structure so that it becomes a standalone asset

that has no structure relations.

Don't use this function if assets are being repaired or temporarily replaced. Instead, use the Replace assetReplace asset  functionality

that is described later in this topic.

1. Select Asset managementAsset management > CommonCommon > AssetsAssets  > All assetsAll assets  or Active assetsActive assets .

2. In the list, select the asset to move. If the asset has child assets, you also move those assets.

3. Select Move assetMove asset.

4. To move the asset so that it becomes part of an asset structure, select the new parent asset in the ParentParent

assetasset field. If you're moving a child asset, and you want to make it a standalone asset that has no structure

relations, leave the Parent assetParent asset field blank.

5. By default, the EffectiveEffective field is set to the current date and time. However, you can select a different date and

time that the asset move is valid from.

6. Select OKOK.

Use the Replace assetReplace asset function in connection with repairs, refurbishment, or permanent replacement of a

worn-out asset by a new asset. This function is used to replace child assets in an asset structure. For parent

assets (that is, assets that don't currently have a parent asset), this replacement is done on a functional location.

For more information about how to replace parent assets on a functional location, see Install assets on

functional locations.
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If a repair shop is related to your production department, you can create functional locations such as RepairRepair , ScrapScrap, and

StorageStorage to handle the repair and replacement of assets.

1. Select Asset managementAsset management > CommonCommon > AssetsAssets  > All assetsAll assets  or Active assetsActive assets .

2. In the list, select the child asset to replace. If the asset has child assets, you also replace those assets.

3. Select Replace assetReplace asset.

The Structure changeStructure change field shows the last date and time that the selected asset and related child assets

were moved in the asset structure.

4. In the Selected assetSelected asset section, in the Target functional locationTarget functional location field, select the functional location to

move the asset to. For example, select the RepairRepair  or ScrapScrap location.

In the Parent assetParent asset section, the EffectiveEffective field shows the last date and time that the parent asset and

related child assets were installed or moved on the current functional location.

5. In the New assetNew asset section, in the AssetAsset field, select the asset to insert as a temporary or permanent

replacement for the selected asset. This asset might currently be located on another functional location,

such as StorageStorage.

6. In the Effective fromEffective from section, the EffectiveEffective field is set to the current date and time by default. However,

you can select a different date and time that the asset replacement is valid from.

7. Select OKOK.

Use the Install assetInstall asset function to install an asset structure on a functional location.

Always select a parent asset. The parent asset and related child assets will be moved to the selected functional location.

1. Select Asset managementAsset management > CommonCommon > AssetsAssets  > All assetsAll assets  or Active assetsActive assets .

2. In the list, select the parent asset to install on another functional location.

3. Select Install assetInstall asset.

The Attr ibutesAttr ibutes  section shows the asset attributes that are set up on the parent asset.

4. In the Functional locationFunctional location field, select the new location.

5. By default, the EffectiveEffective field is set to the current date and time. However, you can select a different date

and time that the installation on the asset structure is valid from.

6. Select OKOK.
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Select asset items

Create assets from pending assets
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Find pending assets

This topic explains how you can create a list of asset items that can be used as a basis for creating assets for

maintenance jobs in Asset Management. Based on the asset items, you are able to view a list of the purchase

order lines that have been created on those items. The purpose of this functionality is to easily create an asset in

Asset Management based on a purchase order.

First, you set up the items to be used for creating assets from a purchase order in Asset itemsAsset items . After creating a

purchase order line, you create the assets in Pending assetsPending assets . It is possible to decide at which stage of the

purchase order the asset should be created.

1. Click Asset managementAsset management > SetupSetup > AssetsAssets  > ItemsItems .

2. Click NewNew  to create a new asset item.

3. Select the item in the Item numberItem number  field. When you leave that field, the item name is automatically inserted

in the Product nameProduct name field.

4. On the GeneralGeneral  FastTab, select an asset type for the item.

5. Select asset manufacturer and model for the item.

6. Save the item.

1. Click Asset managementAsset management > CommonCommon > AssetsAssets  > Pending AssetsPending Assets .

2. You will see an updated list of the purchase orders based on the items selected in Asset itemsAsset items .

3. You can filter the status of purchase orders to select at which lifecycle state the asset should be created. For

example, you may only want to create assets when a product receipt has been posted on a purchase order.

4. Select the Reference numberReference number  link on a purchase order line to view detailed information about the item.

5. If you want to edit which dimensions are displayed on the Inventor y dimensionsInventor y dimensions  FastTab, click the DisplayDisplay

DimensionsDimensions  button, and make your selections.

6. If you want to create an asset based on a purchase order line, select the check box in the MarkMark column for

that line on the list page, and click Create assetsCreate assets . A message will be displayed informing you of the asset ID.

7. Select the asset in the All assetsAll assets  list and click EditEdit to add more information to the asset.

8. In Pending assetsPending assets , if you want to delete a line because you don't want to create an asset, select the check

box in the MarkMark column for that line, and click Discard pending assetsDiscard pending assets . A message will be displayed

informing you of the asset ID. You are not deleting the purchase order or sales order, just the record from

which you could have created an asset in Asset ManagementAsset Management.

All product dimensions (size, color, configuration etc.) are automatically transferred to the asset attributes. Tracking

dimensions (serial number) are stored directly on the asset when the asset is created.

You can run a Pending asset countPending asset count to check for pending assets. For example, this function can be used for

receiving a notification each time a pending asset is ready to be created as an asset.
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1. Click Asset managementAsset management > PeriodicPeriodic > AssetsAssets  > Pending asset countPending asset count.

2. Click OKOK to run the job and update the list in Pending assetsPending assets .

3. You can set up this job to run as a batch job, for example, once each day.

Caution:Caution: If data is changed on a purchase order after you have created an asset based on the appertaining item,

those changes will not be reflected on the asset.
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NOTENOTE

Set up spare parts item groups

View and update asset BOMs

This topic describes asset bills of materials (BOMs) in Asset Management. The Asset BOMAsset BOM page shows a list of

all items (spare parts and other items) that are used on an asset during its whole lifetime. When you create a

new asset, you should consider setting up an asset BOM as a part of the setup procedure. In this way, you can

track item history for the asset from the creation date.

After you've completed a maintenance job, and item consumption has been registered on a work order, you can

track consumption of spare parts and other items that are used on the asset. This functionality lets you keep a

complete item consumption record for all your assets. For example, you can use the record to monitor whether

a specific spare part is often replaced, or to keep track of the spare parts or other items that are currently used

on an asset.

On a work order, item consumption might include both spare parts and other, additional items, such as lubricants, bolts,

and gaskets.

An asset BOM can be automatically updated based on the setup in Asset Management. If a work order lifecycle

state has been created to handle finished or completed work orders, and if the Update asset BOMUpdate asset BOM option for

that work order lifecycle state is set to YesYes  on the Work order lifecycle statesWork order lifecycle states  page, all items that are used on

the work order will be automatically updated on the Asset BOMAsset BOM page when the work order is updated to that

lifecycle state.

You can also manually update an asset BOM by creating new item lines on the Asset BOMAsset BOM page.

On the Asset BOMAsset BOM page, you can track spare parts history for assets after item consumption is registered on a

work order. To use this functionality, you must select the item groups that should be used for spare parts

registration on the Spare par ts item groupsSpare par ts item groups  page.

To use asset BOM functionality, you must first set up the required spare parts items groups. Then, if you want

the asset BOM to be automatically updated when a work order is completed, you can set up a work order

lifecycle state to handle that update.

The setup of spare parts history is based on item groups that are created in the Inventor y and warehouseInventor y and warehouse

managementmanagement module. In Asset Management, you set up item groups so that you can track spare parts history

for the items in the selected item groups.

1. Select Asset managementAsset management > SetupSetup > AssetAsset > Spare par ts item groupsSpare par ts item groups .

2. Select NewNew  to set up an item group.

3. In the Item groupItem group field, select the group. The name of the group is automatically entered in the NameName field.

After you post item consumption on a work order, you can view the registered item consumption on the AssetAsset

BOMBOM page.

1. Select Asset managementAsset management > CommonCommon > AssetsAssets  > Active assetsActive assets . Select the asset in the list, and then
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select Asset BOMAsset BOM.

To view all item consumption registrations on all assets, select Asset managementAsset management  > InquiriesInquiries  > AssetsAssets  >

Asset BOMAsset BOM.

2. Select Update asset BOMUpdate asset BOM. You can add assets, asset types, and resources to the update as you require

by selecting SelectSelect. Select OKOK to start the update. You can also set up the Update function as a batch job.

3. If you want to see more information that is related to the items, you can add inventory dimensions. Select

Inventor yInventor y  > Dimensions displayDimensions display , and then select the check boxes for the dimensions that you want to

see. To keep this setup for all assets on the Asset BOMAsset BOM page, set the Save setupSave setup option to YesYes .

4. To get an overview of where in Asset Management the item on the selected line is used, in relation to

assets, job type defaults, spare parts, and work orders, select Item where usedItem where used.

5. If you want to see only active item lines, select ViewView  > CurrentCurrent. To see all item lines, including lines

where the expiration date is earlier than the current date, select ViewView  > AllAll .

When you've completed a work order, if some items or spare parts that are related to the related asset have expired or

have been replaced by other items or spare parts, we recommend that you update the asset BOM accordingly.

You can manually create item lines for assets.

1. On the Asset BOMAsset BOM page, select NewNew .

2. In the AssetAsset field, select the asset to add an item line for.

3. In the L ine numberLine number  field, enter a sequential line number.

4. In the EffectiveEffective field, enter a start date for the item.

5. If the item will expire, in the ExpirationExpiration field, enter an end date.

6. In the Item numberItem number  field, select the item. The name is automatically entered in the Product nameProduct name field.

7. In the QuantityQuantity  field, enter the quantity that is used. The UnitUnit field is automatically updated.
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This topic explains how to access asset event history in Asset Management. The Asset event histor yAsset event histor y  page

shows the registration history that has been made during the lifetime of an asset. You can access this page from

the All assetsAll assets , Active assetsActive assets , and My active assetsMy active assets  menu items. Select an asset, and then select EventEvent

histor yhistor y .

On the DetailsDetails  FastTab of the Asset event histor yAsset event histor y  page, you can do a search on all the available information.

For example, you can use the asset event history to find the following information:

When a job type was last used on an asset

When a specific worker entered a remark on a work order job

The timeline is updated every time that the page is opened. It contains the following information:

Changes that have been made on the asset: asset location, asset ID, name, and vendor warranty

Asset parent

Asset bill of materials (BOM)

Asset lifecycle state log

Functional location

Maintenance requests

Work orders, including posted item and notes

Faults

Condition assessments
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This topic describes the asset view in Asset Management. The Asset viewAsset view  page shows active assets and

functional locations in a tree view. Therefore, you can easily get an overview of asset relations to functional

locations. Additionally, you can view detailed information about functional locations, assets, and related bills of

materials (BOMs). You can also get a quick overview of active maintenance requests and work orders that are

related to an asset.

NOTENOTE

1. Select Asset managementAsset management > CommonCommon > AssetsAssets  > Asset viewAsset view .

2. To change the view that is shown on the page, select a new value in the ViewView  field.

The default view that is shown when you open the Asset viewAsset view page depends on the value that is selected in the

ViewView field on the AssetsAssets  tab of the Asset management parametersAsset management parameters  page (Asset managementAsset management  > SetupSetup >

Asset management parametersAsset management parameters).

On the right side of the page, FastTabs shows details of the selected view.

The breadcrumb trail that appears above the tree view shows the current selection in the tree view. This

breadcrumb trail uses the following format:

Functional location ID / Functional location ID (if there is more than one functional location) > Asset ID / Asset ID

(if there is more than one asset) - Item number.

If you've selected an asset in the tree view, you can select Active requestsActive requests  or Active work ordersActive work orders  to view the

maintenance requests or work orders that are related to the asset. You can also select OpenOpen > FunctionalFunctional

locationlocation, AssetAsset, or Asset BOMAsset BOM to open the related view.

The Asset functional locationsAsset functional locations  option that you can select in the ViewView  field is also available in any asset

lookup where you can select an asset. The tree view is shown on an Asset viewAsset view  tab, for example, where you

create an asset, create a maintenance request, or create a work order.
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This topic provides an overview of asset attributes in Asset Management. Asset attributes are properties that are

related to an asset type or an asset. If you've set up attribute types and used them on assets, you can get an

overview of the attribute values that are set up on the assets. This overview is shown on two pages in Asset

Management: Asset attr ibute over viewAsset attr ibute over view  and Asset attr ibuteAsset attr ibute.

The Asset attr ibute over viewAsset attr ibute over view  page shows a separate line for each asset. The line shows all attribute types that

are related to that asset. Follow these steps to open and use the Asset attr ibute over viewAsset attr ibute over view  page.

1. Select Asset managementAsset management > Inquir iesInquir ies  > AssetsAssets  > Asset attr ibute over viewAsset attr ibute over view .

2. In the Asset typeAsset type field, select an asset type.

3. Select OKOK. A list shows all the assets that use the selected asset type. For each asset, all related asset attribute

types are shown on the same line.

The Asset attr ibuteAsset attr ibute page shows a separate line for each attribute type that is used on an asset. To open this

page, select Asset managementAsset management > Inquir iesInquir ies  > AssetsAssets  > Asset attr ibuteAsset attr ibute.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/objects/object-specification-overview.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Maintenance requests
2/18/2021 • 2 minutes to read • Edit Online

View maintenance requests

NOTENOTE

You can set up various types of requests to use in your company. Maintenance requests are one type.

Maintenance requests are used to request that a work order be required for a specific job. A maintenance

request can be created by any user who has access to Asset Management functionality. A planner or manager

can then decide whether a maintenance request should be converted to a work order, or whether it should

complete its own lifecycle.

Select Asset managementAsset management > CommonCommon > Maintenance requestsMaintenance requests  > All maintenance requestsAll maintenance requests  or

Active maintenance requestsActive maintenance requests .

The All maintenance requestsAll maintenance requests  list page shows all maintenance requests, regardless of their lifecycle

state. The Active maintenance requestsActive maintenance requests  lists page shows only maintenance requests that are in an

active state.

The following illustration shows an example of the All maintenance requestsAll maintenance requests  list page.
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Set up maintenance request lifecycle states

Maintenance request lifecycle states define the stages that a request can go through. Examples include CreatedCreated,

ActiveActive, and EndedEnded. When a maintenance request is converted to a work order, the maintenance request

lifecycle state should be updated to EndedEnded or ClosedClosed to indicate that the maintenance request is no longer

active. On the All maintenance requestsAll maintenance requests  list page, you can view all maintenance requests, regardless of their

lifecycle state.

1. Select Asset managementAsset management > SetupSetup > Maintenance requestsMaintenance requests  > L ifecycle statesLifecycle states .

2. Select NewNew  to create a maintenance request lifecycle state.

3. In the L ifecycle stateLifecycle state field, enter an ID for the lifecycle state.

4. In the NameName field, enter a name.

On the DetailsDetails  FastTab, the L ifecycle modelsL ifecycle models  field shows the number of maintenance request lifecycle

models that use this lifecycle state.

5. On the GeneralGeneral  FastTab, set the ActiveActive option to YesYes  if a maintenance request should be active while it's

in this lifecycle state.

6. Set the Set actual endSet actual end option to YesYes  if an actual end date and time should automatically be entered on a

maintenance request that is in this lifecycle state.

7. Set the Create work orderCreate work order  option to YesYes  if a work order can be created from a maintenance request

that is in this lifecycle state.

8. Set the DeleteDelete option to YesYes  if a maintenance request can be deleted while it's in this lifecycle state.

9. On the UpdateUpdate FastTab, the InboundInbound and OutboundOutbound options in the AssetAsset section are relevant if you use

depot repair. Set the appropriate option to YesYes  if the asset lifecycle state of assets that are selected on a

maintenance request should automatically be updated to InboundInbound or OutboundOutbound when the maintenance

request lifecycle state of that maintenance request is set to InboundInbound or OutboundOutbound.

The follow illustration shows an example of the Maintenance request lifecycle statesMaintenance request lifecycle states  page.
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Set up maintenance request lifecycle models

Maintenance request lifecycle states, lifecycle state groups, and types are related to, and used in the same way as, work

order lifecycle states, lifecycle state groups, and types.

After you've created the lifecycle states that are required for your maintenance requests, they can be divided into

lifecycle state groups, or lifecycle models. Maintenance request lifecycle models are used to create the flow that

can be used for different types of maintenance requests. At a minimum, one standard maintenance request

lifecycle model should be created.

1. Select Asset managementAsset management > SetupSetup > Maintenance requestsMaintenance requests  > L ifecycle modelsL ifecycle models .

2. Select NewNew  to create a maintenance request lifecycle model.

3. In the L ifecycle modelL ifecycle model  field, enter an ID for the lifecycle model.

4. In the NameName field, enter a name.

On the DetailsDetails  FastTab, the L ifecycle statesLifecycle states  shows the number of lifecycle states that are selected in this

lifecycle model. The Maintenance request typesMaintenance request types  field shows the number of maintenance request types

that use this lifecycle model.

5. On the L ifecycle statesLifecycle states  FastTab, select the lifecycle states that should be included in the lifecycle model:

To include a lifecycle state in the lifecycle model, select it in the L ifecycle states remainingLifecycle states remaining section,

and then select the right arrow button  to move it to the L ifecycle states selectedLifecycle states selected section.

To include all the available lifecycle states in the lifecycle model, select the Select all available statesSelect all available states

button . All lifecycle states are moved to the L ifecycle states selectedLifecycle states selected section.

To remove a lifecycle state from the lifecycle model, select it in the L ifecycle states selectedLifecycle states selected section,

and then select the left arrow button  to move it to the L ifecycle states remainingLifecycle states remaining section.

6. On the GeneralGeneral  FastTab, the fields in the UpdatesUpdates  section are relevant if you use depot repair.
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In the L ifecycle state for asset receivedLifecycle state for asset received field, select the asset lifecycle state that assets that are

selected on a maintenance request should automatically be updated to when they are received for

depot repair.

In the L ifecycle state for asset deliveredLifecycle state for asset delivered field, select the lifecycle state that assets that are selected

on a maintenance request should automatically be updated to when they are returned after repair.

The following illustration shows an example of the Maintenance request lifecycle modelsMaintenance request lifecycle models  page.
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Maintenance request types are used to categorize maintenance requests. For example, you might have

maintenance request types that are related to preventive maintenance and corrective maintenance. Or you

might have a special maintenance request type that is used to manage repair of assets (depot repair).

A maintenance request type defines the affiliation with a maintenance request lifecycle state group

(maintenance lifecycle model). Maintenance request lifecycle models define the lifecycle states that can be set

for a maintenance request. (Examples of maintenance request lifecycle states include CreatedCreated, ActiveActive, and

EndedEnded.)

1. Select Asset managementAsset management > SetupSetup > Maintenance requestsMaintenance requests  > Maintenance request typesMaintenance request types .

2. Select NewNew  to create a maintenance request type.

3. In the Maintenance request typeMaintenance request type field, enter an ID for the maintenance request type.

4. In the NameName field, enter a name.

5. On the GeneralGeneral  FastTab, in the Maintenance request lifecycle modelMaintenance request lifecycle model  field, select a maintenance request

lifecycle model.

6. In the Work order typeWork order type field, select a work order type. When a maintenance request is converted to a work

order, the work order automatically gets the work order type that is related to the maintenance request type.

The following illustration shows an example of the Maintenance request typesMaintenance request types  page.
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Set up responsible maintenance workers

Responsible maintenance workers can be related to asset types, assets, functional locations, maintenance job

type categories, maintenance job types, maintenance job type variants, and trades. They can be used on work

orders and maintenance requests to indicate a preference about the maintenance workers who should be

responsible for a work order. (However, those maintenance workers aren't necessarily the same workers who are

scheduled to carry out the work order.) Use of this functionality is optional. For example, it can be used to select

responsible workers or worker groups for specific work types or work areas.

During a work order lifecycle or a maintenance request lifecycle, responsible maintenance workers can be

changed or updated. This change or update might be related to, for example, a change in the maintenance

request lifecycle state or the work order lifecycle state.

The setup on the Responsible maintenance workersResponsible maintenance workers  page is not used during work order scheduling.

In Asset Management, you can also set up preferred maintenance workers who might be allocated to work orders during

work order scheduling.

Before you can set up responsible maintenance workers, you must set up the workers and maintenance worker

groups that should be available for selection. For information about how to set up workers and maintenance

worker groups, see Maintenance workers and worker groups.

NOTENOTE

1. Select Asset managementAsset management > SetupSetup > WorkersWorkers  > Responsible maintenance workersResponsible maintenance workers .

2. Select NewNew  to create a record.

3. First create a default responsible maintenance worker or responsible maintenance worker group setup,

where you set only the Responsible maintenance worker groupResponsible maintenance worker group field and/or the ResponsibleResponsible

workerworker  field. Leave the remaining fields blank. This default setup will be used during work order

scheduling if no other, more specific combination matches the contents of the work order.

During creation of a maintenance request, when a responsible maintenance worker or responsible maintenance

worker group is made available for selection on the All maintenance requestsAll maintenance requests  page, Asset Management goes

through all responsible maintenance worker records to check for a possible match. It always checks the most

specific combination first. In other words, Asset Management first checks for a match for the TradeTrade field. If no

match is found, it checks for a match for the Maintenance job type variantMaintenance job type variant  field. If no match is found, it checks

for a match for the Maintenance job typeMaintenance job type field, and so on. As you can see in the layout of the page, this

behavior means that, to find the most specific combination, Asset Management checks each record from right to

left for a match (first TradeTrade, then Maintenance job type variantMaintenance job type variant , then Maintenance job typeMaintenance job type, then

Maintenance job type categor yMaintenance job type categor y , then Functional locationFunctional location, then AssetAsset , and finally Asset typeAsset type). If no match

is found, the default record that has no selections in those seven fields is used.

The following illustration shows an example of the Responsible maintenance workersResponsible maintenance workers  page.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/setup-for-maintenance-requests/responsible-workers.md
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View maintenance requests

NOTENOTE

Maintenance requests are notes or declarations that are created to notify a manager or planner that an asset

might require a maintenance or repair job, but without creating a work order. If the contents of a maintenance

request are considered valid, a work order can then be created based on the maintenance request.

Maintenance requests can be created for any asset in Asset Management. Various types of maintenance

requests can be created, depending on how your company uses maintenance requests. Here are some examples:

Maintenance requests

Notes

Corrections or enhancements

Investments

Depot repair (This type is used when you receive assets from another location so that you can do a

maintenance or repair job, and you then return the asset after the job is completed.)

To view maintenance requests, select Asset managementAsset management > CommonCommon > Maintenance requestsMaintenance requests  > AllAll

maintenance requestsmaintenance requests , Active maintenance requestsActive maintenance requests , or My functional location maintenanceMy functional location maintenance

requestsrequests . Each list page shows some of the information that is related to a maintenance request.

Use the My functional location maintenance requestsMy functional location maintenance requests  list page to view a list of maintenance requests that contain

either functional locations that you're related to as a worker or assets that are installed on functional locations that you're

related to as a worker. (For information about how to set up functional locations on maintenance workers, see

Maintenance workers and worker groups.)

Although customer account information is available in Asset Service Management (external maintenance), it isn't available

in Asset Management (internal maintenance).

To open the details view of a record, on the All maintenance requestsAll maintenance requests  list page, in the grid view, select a link

in the Maintenance requestMaintenance request column.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/manage-maintenance-requests/maintenance-request-overview.md
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Edit Edit the selected maintenance request.

New Create a new maintenance request.

Delete Delete the selected maintenance request.

Work order pool Connect the selected maintenance request to a work order
pool.

Work order Create a work order, based on the selected maintenance
request.

Asset fault Click Asset faultsAsset faults , where you can create a fault registration
on the selected maintenance request.

Work orders Show a list of all work orders that are connected to the
selected maintenance request.

The buttons on the Action Pane are organized on tabs. The following table briefly describes the buttons that are

related to Asset Management.



Update maintenance request state Update the maintenance request state.

Lifecycle state log View a log that shows the lifecycle states of the selected
maintenance request.

Maintenance request details Print a report that shows details of the selected maintenance
request.

Send loan asset Select a loan asset that should be a temporary replacement
for the asset that is selected on the selected maintenance
request.

Return loan asset Register the loan asset as returned.

B UT TO N  N A M EB UT TO N  N A M E DESC RIP T IO NDESC RIP T IO N

NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create maintenance requests
2/18/2021 • 3 minutes to read • Edit Online

Maintenance requests can be used if maintenance workers or production workers discover that equipment

requires repair, but the repair job can't be done right away.

Example:Example: While a maintenance worker is making a repair, she discovers that another asset at the same location

must be serviced. However, the maintenance worker doesn't have the time or the required spare parts to do the

repair job. Therefore, she creates a maintenance request on the asset and enters a short description of the issue.

The Active maintenance requestsActive maintenance requests  section of the Related informationRelated information pane on the right side of the AllAll

assetsassets  or Active assetsActive assets  page (Asset managementAsset management > CommonCommon > AssetsAssets  > All assetsAll assets  or Active assetsActive assets )

shows the active maintenance requests that are attached to the selected asset.

1. Select Asset managementAsset management > CommonCommon > Maintenance requestsMaintenance requests  > All maintenance requestsAll maintenance requests  or

Active maintenance requestsActive maintenance requests .

2. Select NewNew .

3. In the Create requestCreate request dialog box, in the Maintenance request typeMaintenance request type field, select the type of

maintenance request. A default type is suggested.

4. In the Descr iptionDescr iption field, enter a name or title that briefly describes the maintenance request.

5. In the Functional locationFunctional location and AssetAsset fields, select a functional location or an asset, or a combination of

a functional location and an asset, as you require. You can create a maintenance request without selecting

an asset, and the asset can be added to the maintenance request later. If the maintenance worker who is

signed in is related to a resource that is related to an asset, the AssetAsset field is automatically set.

If a maintenance request is already attached to the selected asset, a message bar appears at the top of the

Create requestCreate request dialog box to notify you about the ID of the existing maintenance request. A message

bar also notifies you if the asset is covered by a warranty agreement.

6. In the Ser vice levelSer vice level  field, select a service level that indicates the urgency of the request.

7. If you selected an asset in step 5, you can use the Fault symptomFault symptom, Fault areaFault area, and Fault typeFault type fields to

create a fault registration.

8. If the maintenance request has caused maintenance downtime, enter the start date and time of the

downtime.

The Star ted byStar ted by  field is automatically set to your name.

9. The Actual star tActual star t field is automatically set to the current date and time. However, you can change the

value as you require.

10. In the NotesNotes  field, enter any additional notes that are required.

11. Select OKOK.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/manage-maintenance-requests/create-a-maintenance-request.md


Subsequent processing of maintenance requests
After a maintenance request is created, but before it's converted to a work order, various information should be

updated on it. Typically, a planner or another administrative employee completes this task.

On the All maintenance requestsAll maintenance requests  or Active maintenance requestsActive maintenance requests  page, select the request to work

with, and then select EditEdit.

In the details view, you can update various information. Here are some examples:

Select and verify the asset. If you must select a different asset later, you can set the Asset ver ifiedAsset ver ified option to

NoNo.

Select a responsible maintenance worker group and/or a responsible maintenance worker. For more

information about the required setup, see Responsible maintenance workers.

Select a maintenance job type and, if this information is relevant, a related maintenance job variant and a job

trade.

In the LatitudeLatitude and LongitudeLongitude fields, enter geographic coordinates. Any coordinates that are added to a

maintenance request are automatically transferred to a related work order.



NOTENOTE

NOTENOTE

If you select an asset when you create a maintenance request, you can add one fault to the asset. After the maintenance

request has been created, you can add more faults, as you require. To add faults, select Asset faultAsset fault  on the AllAll

maintenance requestsmaintenance requests  page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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After you've created maintenance requests, you can easily convert them to work orders. This topic describes the

quickest way to work with maintenance requests, update several maintenance requests at the same time, and

then create a work order for several maintenance requests at the same time. On the Active maintenanceActive maintenance

requestsrequests  or My functional location maintenance requestsMy functional location maintenance requests  page, you can also work with one maintenance

request at a time and convert one maintenance request to a work order.

Every maintenance request can be related to only one work order. However, multiple maintenance requests can be

included in one work order, even if the maintenance requests have different assets.

1. Select Asset managementAsset management > CommonCommon > maintenance requestsmaintenance requests  > All maintenance requestsAll maintenance requests .

2. Before you can create a work order from maintenance requests, you must select, at a minimum, a

maintenance job type for the maintenance requests, and also a maintenance job type variant and trade, if

this information is relevant. In the grid view, you can easily update information for a maintenance

request.

3. When you're ready to create a work order, select the maintenance requests to include in it.

If you select several maintenance requests to convert to a work order, both the AssetAsset field and the

Maintenance job typeMaintenance job type field must be set before you create the work order.

If you select one maintenance request to convert to a work order, only the AssetAsset field must be set

before you create the work order. However, when you create the work order, you can select a

maintenance job type (and a related maintenance job type variant and trade, if this information is

relevant) in the Create work orderCreate work order  dialog box.

4. Select Work orderWork order .

5. In the Create work orderCreate work order  dialog box, set the fields, and then select OKOK.

A message bar might notify you that a new work order has been created.

Additionally, when you create a work order that is based on a maintenance request, if the asset that is

related to the maintenance request is included in a warranty agreement, a message bar notifies you

about the warranty agreement.

6. Select Asset managementAsset management > CommonCommon > Work ordersWork orders  > All work ordersAll work orders , and open the new work

order.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/manage-maintenance-requests/create-work-order-from-a-maintenance-request.md
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Register asset loans on a maintenance request

NOTENOTE

Register loan assets as returned

If your company receives assets for repair or maintenance jobs from either internal locations or customers, and

if you temporarily loan assets to those locations or customers, Asset Management can track the asset loans.

1. Select Asset managementAsset management > CommonCommon > Maintenance requestsMaintenance requests  > All maintenance requestsAll maintenance requests  or

Active maintenance requestsActive maintenance requests .

2. Select the maintenance request to register an asset loan on, and then select EditEdit.

3. On the RequestRequest page, select Send loan assetSend loan asset.

4. Select the asset, and enter the expected return date.

5. Select OKOK.

You can send a loan asset only if an asset of the same asset type is available.

The asset that you loan must have an asset lifecycle state that allows it to be used as a loan asset, such as InStorageInStorage.

When the asset loan is registered, the asset lifecycle state of the asset is automatically updated to, for example,

OnLoanOnLoan.

To view a list of all the assets that you've loaned to other locations or customers, select Asset managementAsset management >

CommonCommon > Asset loanAsset loan > All asset loansAll asset loans . If the EndedEnded check box is selected for an asset, the asset has been

registered as returned to your company.

On the Active asset loansActive asset loans  page, you can view a list of all the loan assets that haven't yet been returned to your

company.

1. Select Asset managementAsset management > CommonCommon > Asset loanAsset loan > Active asset loansActive asset loans .

2. Select the asset loan to register as returned, and then select Return asset loanReturn asset loan.

3. In the ReturnedReturned field, enter the date and time.

4. Select OKOK.

5. Refresh the Active asset loansActive asset loans  list page, and notice that the asset loan no longer appears in the list.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/manage-maintenance-requests/asset-loan.md
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Register assets as inbound

Register inbound assets as received

If your company does repair jobs or maintenance jobs on assets that are received from other locations or

customers, Asset Management can track both inbound assets that are on their way to your company and

outbound assets that are being returned.

If you want to use inbound and outbound lifecycle states to manage assets that are coming in and being returned, you

must set up maintenance request lifecycle states and lifecycle models to support these actions. For more information, see

Maintenance requests.

The setup of Asset Management determines whether you can work with inbound and outbound assets.

1. Select Asset managementAsset management > CommonCommon > Maintenance requestsMaintenance requests  > Active maintenance requestsActive maintenance requests .

2. Select the maintenance request.

3. Select Update maintenance request stateUpdate maintenance request state.

4. Select InboundInbound (or another lifecycle state that you've created for inbound assets), and then select OKOK.

1. Select Asset managementAsset management > CommonCommon > Inbound/outboundInbound/outbound > Inbound assetsInbound assets .

2. Select the asset or maintenance request.

3. Select Receive assetsReceive assets .

4. In the ReceivedReceived field, enter the date and time. Then select OKOK. The record is removed from the InboundInbound

assetsassets  list page.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/manage-maintenance-requests/inbound-and-outbound-assets.md


Register assets as outbound

Register outbound assets as delivered

NOTENOTE

When you've completed the maintenance or repair job, you can register the asset as returned.

1. Select Asset managementAsset management > CommonCommon > Maintenance requestsMaintenance requests  > Active maintenance requestsActive maintenance requests .

2. Select the maintenance request.

3. Select Update maintenance request stateUpdate maintenance request state.

4. Select OutboundOutbound (or another lifecycle state that you've created for outbound assets), and then select OKOK.

1. Select Asset managementAsset management > CommonCommon > Inbound/outboundInbound/outbound > Outbound assetsOutbound assets .

2. Select the asset or maintenance request.

3. Select Deliver assetsDeliver assets .

4. In the DeliveredDelivered field, enter the date and time. Then select OKOK. The record is removed from the OutboundOutbound

assetsassets  list page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a Maintenance request details report

Create a Maintenance request list report

In Asset Management, you can generate two reports that are related to maintenance requests. One report

shows details, and the other report provides a list that can be used for planning and follow-up.

The Maintenance request detailsMaintenance request details  report shows various information that is related to maintenance requests.

1. Select Asset managementAsset management > Repor tsRepor ts  > Maintenance requestsMaintenance requests  > Maintenance request detailsMaintenance request details .

2. On the Records to includeRecords to include FastTab, you can select specific maintenance requests to include on the report.

3. On the Run in the backgroundRun in the background FastTab, you can set up report generation as a batch job, as you require.

4. Select OKOK to generate the report.

The following illustration shows an example of the Maintenance request detailsMaintenance request details  report.

The Maintenance request listMaintenance request list report shows a list of all maintenance requests of the same request type.

1. Select Asset managementAsset management > Repor tsRepor ts  > Maintenance requestsMaintenance requests  > Maintenance request listMaintenance request list.

2. On the Records to includeRecords to include FastTab, you can make selections to define which maintenance requests are

included on the report.

3. On the Run in the backgroundRun in the background FastTab, you can set up report generation as a batch job, as you require.

4. Select OKOK to generate the report.

The following illustration shows an example of the Maintenance request listMaintenance request list report for all active maintenance

requests.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/manage-maintenance-requests/maintenance-request-reports.md
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Create a maintenance job type category

An asset type is attached to every asset. Asset types define the maintenance job types (and therefore, the

maintenance jobs) that can be performed on assets. When you create a work order, you must select a

maintenance job type. You can select only the maintenance job types that are related to the setup of the asset

type that is used for the asset.

For a graphical overview of assets and maintenance job types, and their connection to work orders, see

Functional locations and assets.

Maintenance job type variants can be set up on a maintenance job type. Maintenance job type variants define

variations of a job type, such as sizes (small, medium, or large), periods (weekly, biweekly, one month, or three

months), and configurations (low standard, flexible, or high performance).

Maintenance job trades provide information about professional trades, such as mechanical, electrical, and

hydraulic trades. Competency requirements can be set up on a maintenance job trade. All maintenance job

trades can be used in relation to all maintenance job types. Selection of a maintenance job type variant and/or

maintenance job trade on a work order is optional.

For each maintenance job type, variations of the maintenance job type setup can be created. For example, if you

have a maintenance job type that is named Ser viceSer vice, you can create the following variations for that

maintenance job type: Trucks 30,000 kmTrucks 30,000 km, Cars 30,000 kmCars 30,000 km, and Vans 30,000 kmVans 30,000 km.

Maintenance job type categories are used to collect a group of maintenance job types for overview purposes.

Examples of maintenance job type categories might include CalibrationCalibration, InspectionInspection, OverhaulOverhaul , and

InstrumentationInstrumentation.

Maintenance checklist templates and maintenance checklist variables are used to set up maintenance checklists.

Maintenance checklists are set up on maintenance job types and used on work orders.

You first set up the required maintenance job type categories, maintenance job type variants, and maintenance

job trades. You then create maintenance job types. Finally, on the Maintenance job type defaultsMaintenance job type defaults  page, you

create all the variations of maintenance job types that are required for your equipment. On that page, you can

also set up forecasts, maintenance checklists, and tools for a combination of maintenance job types.

A maintenance job type can be related to only one maintenance job type category.

1. Select Asset managementAsset management > SetupSetup > JobsJobs  > Maintenance job type categoriesMaintenance job type categories .

2. Select NewNew .

3. In the Maintenance job type categor yMaintenance job type categor y  field, enter an ID for the maintenance job type category.

4. In the NameName field, enter a name.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/setup-for-work-orders/job-groups-and-job-types-variants-trades-and-checklists.md


Create a maintenance job type variant

After you relate maintenance job type categories to maintenance job types, the Job typesJob types  field shows the

number of maintenance job types that are related to this maintenance job type category.

1. Select Asset managementAsset management > SetupSetup > JobsJobs  > Maintenance job type var iantsMaintenance job type var iants .

2. Select NewNew .

3. In the Maintenance job type var iantMaintenance job type var iant field, enter an ID for the maintenance job type variant.

4. In the Descr iptionDescr iption field, enter a description.

5. On the Maintenance job typesMaintenance job types  FastTab, select AddAdd to add a maintenance job type.

6. In the Maintenance job typeMaintenance job type field, select the maintenance job type.

7. Repeat steps 5 through 6 to add more maintenance job types to the maintenance job type variant.

On the DetailsDetails  FastTab, the Job typesJob types  field shows the number of maintenance job types that have been

added to this maintenance job type variant.



Create a maintenance job trade
1. Select Asset managementAsset management > SetupSetup > JobsJobs  > Maintenance job tradeMaintenance job trade.

2. Select NewNew .

3. In the TradeTrade field, enter an ID for the maintenance job trade.

4. In the Descr iptionDescr iption field, enter a description.

5. On the SkillsSkills  FastTab, select AddAdd to add a new skill that should be related to the maintenance job trade.

6. In the SkillSkill  field, select the skill.

7. In the LevelLevel  field, select the skill level.

8. Repeat steps 5 through 7 to add more skills to the maintenance job trade.

On the DetailsDetails  FastTab, the SkillsSkills  field shows the number of skills that have been added to this

maintenance job trade.

9. On the Cer tificatesCer tificates  FastTab, select AddAdd to add a certificate to the maintenance job trade.

10. In the Cer tificate typeCer tificate type field, select the certificate.

11. Repeat steps 9 through 10 to add more certificates to the maintenance job trade.

On the DetailsDetails  FastTab, the Cer tificatesCer tificates  field shows the number of certificates that have been added to

this maintenance job trade.



 Create a maintenance checklist variable
When you create maintenance checklist lines in the maintenance job type default, you must select a

maintenance checklist type. Var iableVariable is one maintenance checklist type. It's used to define a possible result in a

range on a maintenance checklist line that is related to a work order line. A variable lets you create a set of

predefined outcomes without having to make an exact measurement.

Example 1:Example 1: You can measure oil level by defining three values: Level too highLevel too high, Level too lowLevel too low , and LevelLevel

within rangewithin range. For each value, you define whether the value result is PassPass , FailFail , or NoneNone.

Example 2:Example 2: You make a visual inspection of a piece of equipment to assess wear and tear.

1. Select Asset managementAsset management > SetupSetup > Maintenance checklistsMaintenance checklists  > Maintenance checklistMaintenance checklist

var iablesvar iables .

2. Select NewNew .

3. In the VariableVariable field, enter an ID for the maintenance checklist variable.

4. In the NameName field, enter a name.

5. On the GeneralGeneral  FastTab, select AddAdd to add a line for a variable.

A sequential line number is automatically entered in the L ine numberLine number  field. After you've added all the

lines, you can change the line numbers as you require. When you select line and then press the DownDown

arrowarrow  key, the next number in the sequence is automatically entered on the next line.

6. In the ValueValue field, enter a value description.

7. In the ResultResult field, select a result for the line.



  Create a maintenance checklist template
Maintenance checklist templates can be used as a common set of tasks that a worker must perform to complete

a work order correctly. The templates are referenced from maintenance checklist lines on the maintenance job

type default. Templates can be referenced across multiple maintenance job type default lines. Therefore, you can

easily reuse a set of common maintenance checklist tasks. Examples of maintenance checklist templates include

general safety instructions, and a list of items and conditions that must be checked on a specific pump or similar

models of a conveyor belt.

1. Select Asset managementAsset management > SetupSetup > Maintenance checklistsMaintenance checklists  > Maintenance checklistMaintenance checklist

templatestemplates .

2. Select NewNew .

A template ID is automatically entered in the Maintenance checklist templateMaintenance checklist template field.

3. In the NameName field, enter a name for the maintenance checklist template.

4. On the Maintenance checklist linesMaintenance checklist lines  FastTab, select AddAdd to add a template line.

A sequential line number is automatically entered in the L ine numberLine number  field. After you've added all the

lines, you can change the line numbers as you require. When you select line and then press the DownDown

arrowarrow  key, the next number in the sequence is automatically entered on the next line.

5. In the TypeType field, select a type for the maintenance checklist line. For each maintenance checklist type, the

Line detailsL ine details  FastTab shows related fields. The following values are available:

TextText – The line has text that describes what to do. Use this maintenance checklist type if you want a

worker to check or inspect something, but you don't expect a specific (measurable) result. After

you select this type, enter a name or heading in the NameName field. In the InstructionsInstructions  field, enter a

description of what must be done. If the step is mandatory for the maintenance checklist, set the

Mandator yMandator y  option to YesYes .

HeaderHeader  – The line is used as a heading to group the maintenance checklist lines that appear below

it. This type is useful if you have several maintenance checklist lines that can be divided into

specific areas. Headers provide an overview for the worker who will complete a maintenance

checklist that has many maintenance checklist lines. After you select this type, enter a descriptive

name in the NameName field.

TemplateTemplate – The line is used to make a reference to an existing template. After you select this type,

enter a name for the template in the NameName field. In the TemplateTemplate field, select the template.

Var iableVariable – The line is used to define a possible result in a range. For information about how to set



 Create a maintenance job type
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up maintenance checklist variables, see the Create a maintenance checklist variable section. After

you select this type, enter a descriptive name for the variable in the NameName field. In the VariableVariable

field, select the variable. In the InstructionsInstructions  field, enter a description of what must be done. If the

step is mandatory for the maintenance checklist, set the Mandator yMandator y  option to YesYes .

MeasurementMeasurement – The line is used to record a specific measurement. You can set up the

measurement that should be related to a predefined counter. After you select this type, enter a

name for the template in the NameName field. If this step is mandatory for the maintenance checklist,

set the Mandator yMandator y  option to YesYes . If you want to use the measurement line as a counter

registration, select the counter in the CounterCounter  field. The related UnitUnit field is then automatically

updated. If you've selected a counter, select the update method in the ValueValue field. In the Min.Min.

valuevalue and Max. valueMax. value fields, enter the allowed value range. In the InstructionsInstructions  field, enter a

description of what must be done.

Any line of the MeasurementMeasurement  type that doesn't have a counter setup is treated as an independent

measurement registration that there is no automatic follow-up for in Asset Management. Likewise, if the

selected counter type isn't present on the asset that is related to the work order, the maintenance checklist

task is treated as an independent measurement. The counter value can be changed multiple times. It isn't

posted until the work order lifecycle state is changed to a state where the Process maintenanceProcess maintenance

checklistchecklist  option is set to YesYes .

On the DetailsDetails  FastTab, the ChecksChecks  field shows the total number of checklist lines in your template. This

number includes the nested lines in any existing template that you've referenced in your template.

1. Select Asset managementAsset management > SetupSetup > JobsJobs  > Maintenance job typesMaintenance job types .
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2. Select NewNew .

3. In the Maintenance job typeMaintenance job type field, enter an ID for the maintenance job type.

4. In the NameName field, enter a name.

The DetailsDetails  FastTab shows an overview of the number of maintenance job type variants, skills,

certificates, succeeding jobs, and asset types that have been created on this maintenance job type. The

Setup linesSetup lines  field shows the number of maintenance job type default lines that have been set up on this

maintenance job type. The AssetsAssets  field shows the number of active assets that currently use this

maintenance job type.

5. On the GeneralGeneral  FastTab, in the Maintenance job type categor yMaintenance job type categor y  field, select a maintenance job type

category.

6. Set the Maintenance downtime activitiesMaintenance downtime activities  option to YesYes  if the maintenance job type requires a

maintenance stop of the equipment before the job can be performed.

7. On the Descr iptionDescr iption FastTab, enter a description of the maintenance job type.

8. On the Maintenance job type var iantsMaintenance job type var iants  FastTab, you can add variants to the maintenance job type.

9. On the Required skillsRequired skills  and Required cer tificatesRequired cer tificates  FastTabs, you can add skills and certificate

requirements to the maintenance job type.

10. If a specific maintenance job type must be performed next, add it on the Succeeding jobsSucceeding jobs  FastTab. You

can also set up a maintenance job type variant and trade that are related to the maintenance job type. If

the succeeding job should start a specific number of days before or after the job that uses this

maintenance job type has started, enter the number of days in the Delay by daysDelay by days  field. Positive numbers

represent days after the start of the related job, and negative numbers represent days before the

scheduled start of the related job. For example, if you enter 55 , the succeeding job will start five days after

the start of the job that is related to the maintenance job type. If you enter -3-3 , the succeeding job will

start three days before the scheduled start of the job that is related to the maintenance job type.

If you add more than one maintenance job type line, the sequence of the lines indicates the order that they

should be performed in. The sequence starts at the top of the list.

11. On the Asset typesAsset types  FastTab, you can add asset types to the maintenance job type.



Create maintenance job type default lines and related forecasts,
maintenance checklists, tools, description, and attachments
1. Select Asset managementAsset management > SetupSetup > JobsJobs  > Maintenance job type defaultsMaintenance job type defaults .

–or–

Select Asset managementAsset management > SetupSetup > JobsJobs  > Maintenance job typesMaintenance job types , select a maintenance job type,

and then select Maintenance job type defaultsMaintenance job type defaults .

2. Select NewNew .

3. In the Functional locationFunctional location, Asset typeAsset type, ManufacturerManufacturer , ModelModel , and AssetAsset fields, select appropriate

values, depending on how specific the maintenance job type default should be.

4. In the Maintenance job typeMaintenance job type field, select a maintenance job type if it wasn't automatically selected.

5. In the Maintenance job type var iantMaintenance job type var iant and TradeTrade fields, select a maintenance job type variant and a

maintenance job trade as you require.

6. Select ForecastForecast.

7. On the Maintenance job type default forecastMaintenance job type default forecast page, you can make forecasts on hours, items, and

expenses. On the relevant tabs, select AddAdd, and make selections to create the required forecasts for the

maintenance job type.

8. On the Item forecastItem forecast tab, you can select inventory dimensions that should be shown on the item line.

Select Inventor yInventor y  > DimensionsDimensions , select the dimensions to show, set the Save setupSave setup option to YesYes , and

then select OKOK.

9. On the Item forecastItem forecast tab, select Item where usedItem where used to see an overview of where the item on the selected

line is used in Asset Management in relation to assets, maintenance job type default, spare parts, and

work orders.
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The Maintenance forecast totalsMaintenance forecast totals  FastTab shows an overview of forecast totals. This overview includes

the total number of hours and forecast lines that have been created.

To copy the forecast setup from another maintenance job type, select Copy forecastCopy forecast , and then select the

maintenance job type to copy the setup from.

10. Select SaveSave to save your changes.

11. Close the Maintenance job type default forecastMaintenance job type default forecast page to return to the Maintenance job typeMaintenance job type

defaultsdefaults  page.

12. Select Maintenance checklistMaintenance checklist.

13. On the Maintenance job type defaults checklistMaintenance job type defaults checklist page, you can add maintenance checklist lines to the

selected maintenance job type default. On the Maintenance check linesMaintenance check lines  FastTab, select NewNew  to add a

maintenance checklist line.

Line numbers are automatically entered in the L ine numberLine number  field to indicate the sequence of the

maintenance checklist lines. You can edit line numbers as you require. After you've created the first

maintenance checklist line, select the line, and then press the Down arrowDown arrow  key to add a line below it.

Alternatively, you can select a maintenance checklist line and then select NewNew . In this case, a new line is

added above the selected maintenance checklist line.

14. In the TypeType field, select the line type, and then add information that is related to the maintenance

checklist type. For a description of the available types and related fields, see the Create a maintenance

checklist template section.

To copy the maintenance checklist setup from another maintenance job type, select Copy maintenanceCopy maintenance

checklistchecklist , and then select the maintenance job type to copy the setup from.

You can easily create a template from an existing maintenance checklist. You can then reuse the template across

multiple maintenance checklists. The new template will be an exact copy of the active maintenance checklist. Select

Create templateCreate template, and then enter a name for the template. To replace the existing maintenance checklist with a

single line that references the new template, set the ReplaceReplace option to YesYes . You can view the contents of the

template in the Maintenance checklist templatesMaintenance checklist templates details page.

15. Select SaveSave to save your changes.

16. Return to the Maintenance job type defaultsMaintenance job type defaults  page.

17. Select ToolsTools .

18. On the Maintenance job type default toolsMaintenance job type default tools  page, you can add the tools (resources) that should be

used for the maintenance job type. Select NewNew , and then select the tool in the ResourceResource field.

To copy the tool setup from another maintenance job type, select Copy toolsCopy tools , and then select the maintenance

job type to copy the setup from.

19. Select SaveSave to save your changes.

20. Return to the Maintenance job type defaultsMaintenance job type defaults  page.



NOTENOTE

21. Select Work descr iptionWork descr iption.

22. On the Work descr iptionWork descr iption page, select EditEdit, and then add a description that is related to the selected

maintenance job type default, as you require.

23. Select SaveSave to save the description.

If you add a work description here, it overrides any description that is set up for the maintenance job type

on the Maintenance job typesMaintenance job types  page. If you don't add a work description here, any description that is set

up for the maintenance job type is used. Descriptions are automatically transferred to work orders that

use the maintenance job type or maintenance job type default.

24. Return to the Maintenance job type defaultsMaintenance job type defaults  page.

25. To set up attachments on a selected maintenance job type default line, select Attach documentsAttach documents .

Attachments that are set up on a maintenance job type default line are automatically included on work

order lines that use that maintenance job type default line.

26. Select NewNew , and then select a document type.

27. Upload the document or file.

28. Set the fields on the AttachmentsAttachments  page. The attachment setup uses standard document setup

functionality.

29. Select SaveSave to save the attachment.

Attachments on a maintenance job type default line are printed together with a work order report only if the

document types of the attachments are selected on the Document typesDocument types tab of the Asset managementAsset management

parametersparameters  page (Asset managementAsset management  > SetupSetup > Asset management parametersAsset management parameters). Examples of

attachments include guidelines that explain how to complete a specific job or a predefined maintenance checklist

(if you don't use the maintenance checklist functionality for maintenance job type default lines).

On the Maintenance job type defaultsMaintenance job type defaults  page, each line shows the number of forecasted hours, and

also the number of lines that have been created for items, expenses, maintenance checklists, and tools.

The AssetsAssets  field shows the number of active assets that are related to the maintenance job type default

line.

30. To copy a maintenance job type default to another maintenance job type default, select the maintenance

job type default line to copy another setup to, select Copy setupCopy setup, and then select the maintenance job

type default to copy.

31. To view a list of the assets, maintenance plans, or maintenance rounds that currently use a maintenance

job type default line, select the line, and then select Used byUsed by .



Overview of maintenance job types that are related to assets

When the system selects the available maintenance job type default that should be used on a work order line,

the selection is based on the asset and the related asset type setup. Asset Management goes through all

maintenance job type default records that are related to the maintenance job type that is related to the asset

type to check for a possible match. It always checks the most specific combination first. In other words, to find

the most specific combination, Asset Management first checks for a possible match for the TradeTrade field. If no

match is found, it checks for a match for the Maintenance job type var iantMaintenance job type var iant field. If no match is found, it

checks for a match for the Maintenance job typeMaintenance job type field, and so on (TradeTrade, then Maintenance job typeMaintenance job type

variantvar iant, then Maintenance job typeMaintenance job type, then AssetAsset, then ModelModel , then ManufacturerManufacturer , and then Asset typeAsset type). If

no match is found, the default record where only the maintenance job type is selected is used.

A project activity ID is automatically related to each maintenance job type default line that you create. The

project activity is created on the forecast project that is selected in the Maintenance forecast projectMaintenance forecast project field on

the AssetsAssets  tab of the Asset management parametersAsset management parameters  page. The purpose of the project activity is to manage

forecasts on hours, items, and expenses in relation to work orders. Maintenance job type forecasts are

automatically transferred to the work order line, and they are copied from the forecast project to the work order

project that is created for the work order line. The purpose of the project activity is to manage forecasts in

relation to work orders.

You can set up a batch job to update maintenance job type default references at regular intervals, or you can

manually run the job. To create a batch job or run a manual update, select Asset managementAsset management > PeriodicPeriodic >

Preventive maintenancePreventive maintenance > Update maintenance job type default referencesUpdate maintenance job type default references .

After you've created the required maintenance job type default combinations, you can use the All assetsAll assets  page

to get an overview of the current maintenance job type default that is related to a specific asset. The overview

shows all maintenance job type default combinations that can be used on the asset type that is selected for the

asset. These combinations include combinations that have variations of maintenance job type variants and

maintenance job trades.

1. Select Asset managementAsset management > CommonCommon > AssetsAssets  > All assetsAll assets  or Active assetsActive assets .

2. In the list, select the asset to see an overview of maintenance job type combinations for.

3. On the Action Pane, on the GeneralGeneral  tab, in the Related informationRelated information group, select Maintenance jobMaintenance job

typestypes .

The left pane of the Asset maintenance job typesAsset maintenance job types  page shows a list of all the maintenance job type

combinations that are related to the selected asset.

4. Select a maintenance job type combination to see the related setup for maintenance checklists, forecasts,

and tools. The DetailsDetails  section on the Maintenance job type defaultsMaintenance job type defaults  FastTab shows the number of

related maintenance checklists, forecasted hours, items, and so on, that are related to the selected



Automatic update of maintenance job type forecasts
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maintenance job type combination.

5. To view details for the selected maintenance job type, select Maintenance job typesMaintenance job types .

In Asset Management, you can automatically update any changes to maintenance job type forecasts for hour

costs, item costs, and expenses that have been updated in other modules. In this way, you help guarantee that

your maintenance job type forecasts always use the latest cost prices.

1. Select Asset managementAsset management > PeriodicPeriodic > ForecastForecast > Update maintenance job type forecastUpdate maintenance job type forecast.

2. In the Update maintenance job type forecastUpdate maintenance job type forecast dialog box, on the Records to includeRecords to include FastTab, you can

add selections for specific maintenance job types as you require. Select FilterFilter , and then select SelectSelect to

make the selections.

3. On the Run in the backgroundRun in the background FastTab, you can set up the automatic update as a batch job, as you require.

4. Select OKOK to start the forecast update.

Can you tell us about your documentation language preferences? Take a short survey.
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Work order lifecycle states define the states that a work order can go through. Examples include CreatedCreated,

ScheduledScheduled, In progressIn progress , and EndedEnded. Work order lifecycle states can be manually updated on a work order, or

they can be automatically updated (for example, during work order scheduling).

The work order lifecycle states that are required for your work orders must be attached to matching project

stages on the Project management and accounting parametersProject management and accounting parameters  page (Project management andProject management and

accountingaccounting > Project management and accounting parametersProject management and accounting parameters ). You first set up project stages in Project

management and accounting. You then set up work order lifecycle states and work order lifecycle models in

Asset Management.

The following table describes the options in the Work orderWork order  and ScheduleSchedule sections on the GeneralGeneral  FastTab of

the Work order lifecycle stateWork order lifecycle state page (Asset managementAsset management > SetupSetup > Work ordersWork orders  > L ifecycle statesLifecycle states ).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/setup-for-work-orders/work-order-lifecycle-states.md
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Active Set this option to YesYes if the work order should be active
while it's in this lifecycle state.

Add line Set this option to YesYes if work order jobs can be added to a
work order that is in this lifecycle state.

Delete Set this option to YesYes if a work order can be deleted while
it's in this lifecycle state.

Delete line Set this option to YesYes if work order jobs can be deleted from
a work order that is in this lifecycle state.

Allow scheduling Set this option to YesYes if a work order can be scheduled while
it's in this lifecycle state.

Set actual start Set this option to YesYes if the user should be prompted to
select an actual start date and time for a work order when
it's updated to this lifecycle state.

Set actual end Set this option to YesYes if the user should be prompted to
select an actual end date and time for a work order when it's
updated to this lifecycle state.

Post journals Set this option to YesYes if work order journals should be
automatically posted when a work order is updated to this
lifecycle state. If an error occurs during journal posting, a
message is shown, and the update of the work order lifecycle
state is canceled. To view the journal lines for a work order,
select Asset managementAsset management  > CommonCommon > Work ordersWork orders  >
All work ordersAll work orders , Active work ordersActive work orders , or My activeMy active
work orderswork orders , select the work order in the list, and then
select JournalsJournals . This setup of automatic work order journal
posting at a specific lifecycle state is the same as when you
select Post journalsPost journals  on the Work order journalsWork order journals  page.

Process maintenance checklist Set this option to YesYes if all attached maintenance checklists
should be processed when a work order is updated to this
lifecycle state. As part of this processing, any counter
registrations that were made on a maintenance checklist are
posted, and the result of the whole maintenance checklist is
evaluated. Maintenance checklist lines that have PassPass and
FailFail results are evaluated, and if at least one line fails, the
whole maintenance checklist is marked as FailedFailed in Asset
Management.

Ready Set this option to YesYes if the work order job schedule status
for all work order jobs that are created on a work order
should automatically be updated to ReadyReady when the work
order is updated to this lifecycle state.

Note:Note:  If you set this option to YesYes , journals are
automatically posted if no approval workflow has been
set up. If your company uses the journal approval setup
that is configured on the Journal approvalJournal approval page
(Project management and accountingProject management and accounting > SetupSetup >
JournalsJournals  > Journal approvalJournal approval), a manager or clerk
must validate and post consumption registrations.



Start Set this option to YesYes if the work order job schedule status
for all work order jobs that are created on a work order
should automatically be updated to Star tedStar ted when the work
order is updated to this lifecycle state.

End Set this option to YesYes if the work order job schedule status
for all work order jobs that are created on a work order
should automatically be updated to EndedEnded when the work
order is updated to this lifecycle state.

Delete schedule lines Set this option to YesYes if scheduling on all work order jobs
that are created on a work order that has already been
scheduled should be deleted when the work order is
updated to this lifecycle state. In other words, capacity
reservations on the asset, the related maintenance worker,
and related tools will be deleted. For example, you set this
option to YesYes on a work order lifecycle state that is named
EstimatedEstimated. Then, when a work order is rolled back to this
lifecycle state because rescheduling is required, scheduling
can be deleted on that work order.
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Set up project stages and work order lifecycle states

IMPORTANTIMPORTANT

1. Select Project management and accountingProject management and accounting > SetupSetup > Project management and accountingProject management and accounting

parametersparameters .

2. On the Project stageProject stage tab, for each stage that you want to use, select the check box for every project type

that is required for your work orders. The project types define rules about the financial tasks that are

allowed. Examples of financial tasks include creating a forecast, creating estimates, and creating

beginning balances.

If a project stage isn't selected for a project type, but the project stage is used for a work order lifecycle state, the

work order projects won't be updated in the appropriate manner.

3. Close the Project management and accounting parametersProject management and accounting parameters  page.

4. Select Asset managementAsset management > SetupSetup > Work ordersWork orders  > L ifecycle statesLifecycle states .

5. Select NewNew  to create a work order lifecycle state.

6. In the L ifecycle stateLifecycle state field, enter an ID for the lifecycle state.

7. In the NameName field, enter a name.

On the DetailsDetails  FastTab, the L ifecycle modelsL ifecycle models  field shows the number of work order lifecycle models

that use this lifecycle state.

8. On the GeneralGeneral  FastTab, in the Work orderWork order  section, select the functions that should be available for this

lifecycle state by setting the relevant options to YesYes . For descriptions of the options, see the table earlier

in this topic.

9. In the ProjectProject section, in the StageStage field, select the project stage that should be related to this lifecycle

state.
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10. In the ProjectProject section, set the Close activitiesClose activities  option to YesYes  if project activities that are related to each

work order job should be automatically closed when the work order is in this lifecycle state.

To find the number of the project activity that is related to a work order job, select Asset managementAsset management  >

CommonCommon > Work ordersWork orders  > All work ordersAll work orders , Active work ordersActive work orders , or My active work ordersMy active work orders . Open the

work order, and then select the work order job. The activity number is shown in the Activity numberActivity number  field in the

ProjectProject  section on the GeneralGeneral tab of the Line detailsLine details  FastTab.

11. In the ForecastForecast section, set the Copy hour forecastCopy hour forecast, Copy item forecastCopy item forecast, and/or Copy expenseCopy expense

forecastforecast option to YesYes  if work order project forecasts should automatically be copied to work order

journals when the work order is in this lifecycle state.

12. In the ScheduleSchedule section, set one of the options to YesYes  if the schedule status for work order jobs should

be updated when the work order is in this lifecycle state. For descriptions of the ReadyReady , Star tStar t, EndEnd, and

Delete schedule linesDelete schedule lines  options, see the table earlier in this topic.

To view schedule lines that are related to work order jobs, select Asset managementAsset management  > CommonCommon > WorkWork

ordersorders  > All work ordersAll work orders , Active work ordersActive work orders , or My active work ordersMy active work orders . Open the work order, select the

work order job on the Work order jobsWork order jobs FastTab, and view related information on the Line detailsLine details  FastTab. The

StatusStatus field on the ScheduleSchedule tab shows the status of the work order job. The StatusStatus field can be set to the

following values: ScheduledScheduled, ReadyReady , Star tedStar ted, StoppedStopped, and EndedEnded.

13. In the Maintenance requestsMaintenance requests  section, in the L ifecycle stateLifecycle state field, select the maintenance request

lifecycle state that related maintenance requests should be updated to. This update occurs automatically.

It can be done only if the maintenance request lifecycle state is selected in the maintenance request

lifecycle model that is used for the maintenance request.

14. In the AssetAsset section, set the Update asset BOMUpdate asset BOM option to YesYes  if all items that are used on a work order

should automatically be updated on the Asset BOMAsset BOM page when the work order is updated to this

lifecycle state. This setting might be relevant if, for example, the work order lifecycle state defines the

work order as completed or ended.

15. In the Work order poolWork order pool  section, set the Delete pool referenceDelete pool reference option to YesYes  if work orders that are in

this lifecycle state should automatically be deleted from work order pools.

16. On the ValidateValidate FastTab, select the validation types that should be activated in this lifecycle state by

setting the relevant options to YesYes . Then, in the TypeType field for each validation type that you select, select

the type of message that should be shown if mandatory fields that are related to the validation type

haven't been validated. If you select ErrorError , the update of the work order lifecycle state is canceled until

the related mandatory fields have been updated on the work order.

The Maintenance downtimeMaintenance downtime, Maintenance checklistMaintenance checklist, Fault symptomFault symptom, Fault causeFault cause, and FaultFault

remedyremedy  options are related to the options in the Mandator yMandator y  section on the Work order typesWork order types  page

(Asset managementAsset management > SetupSetup > Work ordersWork orders  > Work order typesWork order types ). To activate these validations,

the related options must also be set to YesYes  on the work order type that is used for the work order.

If the Maintenance checklistMaintenance checklist option is set to YesYes  for the lifecycle state that a work order is updated

to, validation is done to verify that maintenance checklist lines that are marked as Mandator yMandator y  have

been registered as either CheckedChecked or Not applicableNot applicable. If neither of those registrations has been

made on the mandatory lines, an informational, error, or warning message is shown when the work

order is updated to this lifecycle state.
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Relations among work order lifecycle models, work order types, and
work order lifecycle states

If the Committed costCommitted cost option is set to YesYes  for the lifecycle state that a work order is updated to, total

amount of committed costs (that is, the total amount of expenses that the legal entity has committed

to pay) are calculated for each work order job. A message is shown if the committed cost amount is

more than 0 (zero). You select the types of cost commitment that are included on the CostCost

commitmentscommitments  FastTab on the Cost controlCost control  tab of the Project management and accountingProject management and accounting

parametersparameters  page (Project management and accountingProject management and accounting > SetupSetup > Project management andProject management and

accounting parametersaccounting parameters ).

If the Maintenance downtimeMaintenance downtime option is set to YesYes  for the lifecycle state that a work order is updated

to, maintenance downtime validation is done on the asset that is related to the work order. If a

maintenance downtime registration has been made, but there is no EndedEnded registration, a message is

shown when the work order is updated to this lifecycle state.

If the standard project setup doesn't include all the stages that you require for your Asset

Management setup, you can set up user-defined project stages on the Project stageProject stage tab of the

Project management and accounting parametersProject management and accounting parameters  page. The following illustration shows the

Project stageProject stage tab on the Project management and accounting parametersProject management and accounting parameters  page.

If the lifecycle state that you update a work order to is inactive, journals that are related to the work order but that

haven't yet been posted are automatically deleted. This behavior helps guarantee automatic cleanup of unused data. (A

lifecycle state is inactive if the ActiveActive option for it is set to NoNo on the GeneralGeneral FastTab of the Work order lifecycleWork order lifecycle

statestate page.)

However, if you manually set a work order so that it's inactive, journals that are related to the work order but that haven't

yet been posted are notnot  automatically deleted. (To manually inactivate a work order, select Asset managementAsset management  >

CommonCommon > Work ordersWork orders  > All work ordersAll work orders  or Active work ordersActive work orders . Open the work order, and switch to the

HeaderHeader  view. On the GeneralGeneral FastTab, select EditEdit , and then set the ActiveActive option to NoNo.)

Lifecycle models refer to workflows, and lifecycle states are selected in a lifecycle model in sequential order.

Lifecycle models are set up on work order types. Work order types determine the size or extent of workflows

and work processes. For example, MaintenanceMaintenance, which is a standard work order type, might be related to a

work order lifecycle model that has many lifecycle states. By contrast, you might have a CorrectiveCorrective work order

type that is used for work orders that haven't been scheduled, or for work orders where the job is completed

before the work order is made because of an urgent situation. This work order type might be related to a work

order lifecycle model that has only a few lifecycle states.
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Work order lifecycle models

The reason for using types is that when a type is defined on, for example, a work order or an asset, the related

work processes (lifecycle states) are automatically defined. For more information about how to set up work

order types, see Work order types.

Lifecycle states, lifecycle models, and types apply to functional locations, assets, and maintenance requests, in addition to

work orders.

The following illustration shows the relation between work order types, lifecycle models, and lifecycle states.

After you've created the work order lifecycle states that are required for your work orders, they can be divided

into work order lifecycle models. At a minimum, you should create one standard lifecycle model.

1. Select Asset managementAsset management > SetupSetup > Work ordersWork orders  > L ifecycle modelsL ifecycle models .

2. Select NewNew  to create a work order lifecycle model.

3. In the L ifecycle modelL ifecycle model  field, enter an ID for the lifecycle model.

4. In the NameName field, enter a name.

On the DetailsDetails  FastTab, the L ifecycle statesLifecycle states  field shows the number of lifecycle states that are selected

in this lifecycle model. The Work order typesWork order types  field shows the number of work order types that use this

lifecycle model.

5. On the L ifecycle statesLifecycle states  FastTab, select the lifecycle states that should be included in the lifecycle model:
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To include a lifecycle state in the lifecycle model, select it in the L ifecycle states remainingLifecycle states remaining section,

and then select the right arrow button  to move it to the L ifecycle states selectedLifecycle states selected section.

To include all the available lifecycle states in the lifecycle model, select the Select all availableSelect all available

stagesstages  button . All lifecycle states are moved to the L ifecycle states selectedLifecycle states selected section.

To remove a lifecycle state from the lifecycle model, select it in the L ifecycle states selectedLifecycle states selected section,

and then select the left arrow button  to move it to the L ifecycle states remainingLifecycle states remaining section.

6. Select L ifecycle state updatesLifecycle state updates  to define the lifecycle states that can follow a selected lifecycle state.

7. On the UpdatesUpdates  FastTab, in the Scheduled stateScheduled state field, select the lifecycle state that should always be

selected for a work order that you've completed work order scheduling for, regardless of the previous

lifecycle state of the work order.

8. In the Unscheduled lifecycle stateUnscheduled lifecycle state field, select the lifecycle state that should always be selected for a

work order if work order scheduling is deleted.

9. Save the work order lifecycle model.

Can you tell us about your documentation language preferences? Take a short survey.
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https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Work order types
2/18/2021 • 2 minutes to read • Edit Online

Work order types are used to categorize work orders. For example, you might have work orders that are related

to preventive maintenance or corrective maintenance.

A work order type defines an affiliation with a work order lifecycle model. A work order lifecycle model defines

the work order lifecycle states that can be set on a work order. (Examples of work order lifecycle states include

CreatedCreated, In ProcessIn Process , and FinishedFinished.)

For more information about work order lifecycle states and project stages, see Work order lifecycle states.

NOTENOTE

1. Select Asset managementAsset management > SetupSetup > Work ordersWork orders  > Work order typesWork order types .

2. Select NewNew  to create a work order type.

3. In the Work order typeWork order type field, enter an ID for the work order type.

4. In the NameName field, enter a name.

5. In the Work order lifecycle modelWork order lifecycle model  field, select a lifecycle model.

6. Set the One maintenance workerOne maintenance worker  option to YesYes  if all work order jobs that are related to a work order

of this type should be scheduled to the same maintenance worker.

7. In the Cost typeCost type field, select CorrectiveCorrective, PreventivePreventive, or InvestmentInvestment, as appropriate. All work order

jobs on a work order must have the same cost type.

8. In the Mandator yMandator y  section, set the relevant options to YesYes  to specify which fault-related or maintenance

downtime–related information is added to a work order of this type.

The options in the Mandator yMandator y  section are related to the options on the ValidateValidate FastTab of the Work orderWork order

lifecycle stateslifecycle states page (Asset managementAsset management  > SetupSetup > Work ordersWork orders  > Lifecycle statesLifecycle states).

9. Select SaveSave.
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Project setup for a work order job

Set up work order projects

In the Asset managementAsset management module, a project relation is required for every work order job. The project that is

associated with a work order job lets you track costs on various projects that are related to Asset Management,

such as internal maintenance projects, service management projects, and investment projects.

When you create a work order job on a work order, the project setup in the Project management andProject management and

accountingaccounting module and the work order project setup in the Asset managementAsset management module determine how

projects can be used for cost control on the asset that is selected on that work order job. This section describes

the following parts of the project setup that is used for a work order : the parent project (project ID), project type,

project activities, and financial dimensions:

When you create a work order job on a work order, a unique project ID and a related project activity are

automatically created for it. However, if several work order jobs on a work order include the same asset,

the same project ID is used for them. In other words, one project ID is created for every asset on a work

order.

The parent project (project ID) for a work order job is found in the parent project setup. (For more

information about the parent project setup, see the next section.) For example, if you associate a

customer or a functional location with a specific parent project, the parent project is used every time

that you create work orders for that customer or that functional location. If you don't relate a specific

project ID to, for example, a functional location, the next relevant parent project in the work order

project setup is used.

A project type is required for every project ID. The project type is found in the setup of the project

group setup. (For more information about the project group setup, see the next section.) If no match is

found in the project group setup, the project group setup on the parent project is used.

The setup for requiring project activities on forecasts and journals is copied from the parent project to

the work order project. If the HourHour , ExpenseExpense, and ItemItem options are set to YesYes  for the project that is

used as a parent project, a project activity is mandatory on forecasts and journals. (To access these

options, select Project management and accountingProject management and accounting > ProjectsProjects  > All ProjectsAll Projects , and then select

the project that is used as a parent project. The options are in the Require activity on journalsRequire activity on journals

section on the SetupSetup FastTab.)

Financial dimensions are copied from the asset and merged with the parent project.

The next section explains how to set up parent projects and project groups. Parent project and parent groups are

used to control work orders. They are also used for reporting about work orders.

Before you start to create work orders, you must set up work order projects. The Work order project setupWork order project setup

page (Asset managementAsset management > SetupSetup > Work ordersWork orders  > Project setupProject setup) contains two tabs: Parent projectParent project and

Project groupProject group.

On the Parent projectParent project tab, you can set up project relations that can be used if no project is set up on the asset

that is selected on the work order job. A parent project setup isn't required if your company uses asset projects.

It's relevant only if you want to use work order projects instead of asset projects. In that case, you must set up at

least one parent project.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/setup-for-work-orders/work-order-project-setup.md


On the Project groupProject group tab, you can set up project groups that can be associated with work order types, asset

types, and assets.

Project groups can be used to create specific categories (groups) that are used for cost control. For example, by

creating project groups for specific asset types or work order types, you can do detailed tracking of maintenance

costs by type.

Project groups aren't mandatory. If you don't set up project groups, the parent project is used to determine the

project group, and a child project is created from the parent project's project group.

The setup allows for complete integration with the Project management and accountingProject management and accounting module. Therefore,

you can track the costs that are related to work orders in the related projects. The following procedure describes

the setup for work order projects.

1. Select Asset managementAsset management > SetupSetup > Work ordersWork orders  > Project setupProject setup.

2. On the Parent projectParent project tab, select AddAdd.

3. In the Work order typeWork order type, Functional locationFunctional location, Asset typeAsset type, and AssetAsset fields, select values as you

require. For each line that you add, you can set just one field or multiple fields. The number of fields that

you set determines the combination that is used when a project ID is selected in Asset Management.

If you select a functional location, the related child locations are automatically included. If you select an

asset, you can create more work order project setup lines for the same asset, but you can select different

projects for that asset.

4. In the Project IDProject ID field, select the project that should be related to the setup that you created in step 3.

5. If the project setup should be valid for only a limited period, select an end date in the End dateEnd date field.

Otherwise, select NoneNone.

By default, the start date is the date when you add the work order project to the page. It's controlled by

the Valid fromValid from field, which is hidden by default. To show the Valid fromValid from field, select ViewView  > AllAll . You can

then use the Valid fromValid from field together with the End dateEnd date field to set up a limited period of validity for

the work order project.

6. On the Project groupProject group tab, select AddAdd.

7. In the Work order typeWork order type field, select a work order type.

8. If you want the project group association to be more specific, select an asset type in the Asset typeAsset type field

or an asset in the AssetAsset field.

9. In the Project groupProject group field, select the project group that should be related to the work order type. For

example, a work order type that is named Preventive maintenancePreventive maintenance might be associated with a project

group that is named Prev MaintPrev Maint or InternalInternal . Alternatively, an InvestmentInvestment work order type that is used

for work orders that are related to investments and fixed assets might be associated with a project group

that is named InvestInvest or InvestmentInvestment.

10. Select SaveSave.



NOTENOTE

NOTENOTE

Every time that a work order line is created, Asset Management searches for a project group that should be related to the

work order job project. The search is based on the setup that is described in this topic. Every project group has a related

project type. Project groups that have the Time and materialTime and material or Fixed-priceFixed-price project type are valid only for assets that

are related to a customer account.

For parent projects and project groups, when the system selects the available work order project or project group, the

selection is based on the records that you created by using the preceding procedure. Asset Management goes through

records that are related to the work order project to check for a possible match. It always checks the most specific

combination first. In other words, for the work order parent project, Asset Management first checks for a possible match

for the AssetAsset  field. If no match is found, it checks for a match for the Asset typeAsset type field. If no match is found, it checks for

a match for the Functional locationFunctional location field, and so on. As you can see in the layout of the Work order project setupWork order project setup

page, this behavior means that, to find the most specific combination, Asset Management checks each record from right

to left for a match. If no match is found, the default record where only a project ID is selected is used. The process for

finding the related project group is similar. Asset Management first checks for a possible match for the AssetAsset  field, then

the Asset typeAsset type field, and then the Work order typeWork order type field. If no match is found, the default record where only a project

group is selected is used.
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Create a service level

When you create a work order, you might want to define the service levels for it and add a general description to

it. You can create work order service levels on the Work order ser vice levelsWork order ser vice levels  page and descriptions on the

Work order descr iptionWork order descr iption page.

1. Select Asset managementAsset management > SetupSetup > Work ordersWork orders  > Ser vice levelSer vice level .

2. Select NewNew .

3. In the Ser vice levelSer vice level  field, enter the service level (for example, a number).

4. In the NameName field, enter a name.

On the Work ordersWork orders  FastTab, you can define expected start and end dates and times. The fields on this

FastTab define the period that work orders should be started and ended during. They are used for work

orders that are manually created and work orders that are created based on maintenance requests.

5. In the Star t dayStar t day  field, enter a number of days to define the period that the work order should start

during. The number of days is calculated from the creation date of the work order. For example, if the

work order should start when it's created, enter 00 . If the work order should start within one week after it's

created, enter 77 .

6. To set a start time for the work order, in addition to a start date, set the Set star t timeSet star t time option to YesYes .

Then enter the start time in the Star t timeStar t time field. If you set the option to NoNo, the current time of day is

used.

7. In the End dayEnd day  field, enter a number of days to define the period that the work order should end during.

The number of days is calculated from the start date of the work order. For example, if the work order

should end within one week of its start date, enter 77 .

8. To set an end time for the work order, in addition to an end date, set the Set end timeSet end time option to YesYes .

Then enter the end time in the End timeEnd time field. If you set the option to NoNo, the current time of day is used.

9. Select SaveSave.
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Create a description

NOTENOTE

1. Select Asset managementAsset management > SetupSetup > Work ordersWork orders  > Descr iptionsDescr iptions .

2. Select NewNew .

3. In the Descr iptionDescr iption field, enter the description.

4. Select SaveSave.
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You can use work order service levels to set up scheduled execution. (For more information about work order

service levels, see Service level and description.) Scheduled execution provides flexibility in work planning for

maintenance workers, because you can set up more detailed or less detailed requirements for the interval that a

work order should be completed during. For example, a maintenance worker who completes a job faster than

expected in a production facility might be able to move on to another nearby job that was planned for the

current week but not necessarily for the current day. This approach allows for optimization of worker planning

and job completion.

Scheduled execution setup, which is related to work orders, can be generic or specific. You can set up generic

lines that aren't limited to specific work order types, asset types, and so on. Alternatively, you can create

scheduled execution lines that apply to a specific work order type, asset type, maintenance job type, and so on.

1. Select Asset managementAsset management > SetupSetup > Work ordersWork orders  > Scheduled executionScheduled execution.

2. Select NewNew  to create a scheduled execution line.

3. In the Functional locationFunctional location, Work order typeWork order type, Asset typeAsset type, ManufacturerManufacturer , ModelModel , Maintenance jobMaintenance job

type categor ytype categor y , Maintenance job typeMaintenance job type, Maintenance job type var iantMaintenance job type var iant, and TradeTrade fields, select values as

you require.

4. In the Ser vice levelSer vice level  field, select a work order service level. If you leave this field blank, you make the most

generic type of scheduled execution line. For an example of a generic line, see the first record in the

illustration that follows. That line enables all work orders that have no work order service level to be

scheduled for a specific date and time.

5. In the Scheduled executionScheduled execution field, select the time interval.

6. Select SaveSave.

Can you tell us about your documentation language preferences? Take a short survey.
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Create fault symptoms

Create fault areas

In Asset Management, you can use the fault designer to set up fault symptoms, fault areas, and fault types on

asset types. In this way, you can manage faults that are detected on assets. Additionally, fault causes and

suggestions for fixing faults can be registered on a work order.

The process for fault registration and management consists of these steps.

1. Create a list of fault symptoms, fault areas, and fault types that might occur on your asset types.

2. In the fault designer, set up symptoms, fault areas, and fault types.

Here are some examples to help you understand the difference between fault symptoms, fault areas, and fault

types.

Fault symptoms:Fault symptoms:

Unbalanced voltages

Short circuit

Noise

Leak

Vibrations

Fault areas:Fault areas:

Electrical

Mechanical

Hydraulic

Pneumatic

Fault types:Fault types:

Faulty main stator winding

Faulty diode

Dirty windings

Defective generator

Defective sensor

Follow these steps to create a list of symptoms that can be used in the fault designer.

1. Select Asset managementAsset management > SetupSetup > FaultFault > Fault symptomsFault symptoms .

2. Select NewNew  to create a record.

3. In the Fault symptomFault symptom field, enter a name for the fault symptom.

4. In the Descr iptionDescr iption field, enter a description.

5. Select SaveSave.

Follow these steps to create a list of areas or locations that can be used in the fault designer.
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Create fault types

Set up the fault designer

1. Select Asset managementAsset management > SetupSetup > FaultFault > Fault areasFault areas .

2. Select NewNew  to create a record.

3. In the Fault areaFault area field, enter a name for the fault area.

4. In the Descr iptionDescr iption field, enter a description.

5. Select SaveSave.

Follow these steps to create a list of fault types that can be used in the fault designer.

1. Select Asset managementAsset management > SetupSetup > FaultFault > Fault typesFault types .

2. Select NewNew  to create a record.

3. In the Fault typeFault type field, enter a name for the fault type.

4. In the Descr iptionDescr iption field, enter a description.

5. Select SaveSave.

In the fault designer, you set up fault data on asset types.

NOTENOTE

1. Select Asset managementAsset management > SetupSetup > FaultFault > Fault designerFault designer .

2. In the left pane, select the type of asset to set up a fault record for.

3. On the Fault symptomFault symptom FastTab, select Add lineAdd line, and then, in the Fault symptomFault symptom field, select a fault

symptom.

4. On the Fault areaFault area FastTab, select Add lineAdd line, and then, in the Fault areaFault area field select a fault area.

5. On the Fault typeFault type FastTab, select Add lineAdd line, and then, in the Fault typeFault type field, select a fault type.

6. To quickly create combinations of all existing fault symptoms, areas, and types for the selected asset type,

select Create fault combinationsCreate fault combinations . This function is useful if you've added many fault symptoms, areas,

and types. It's easier to delete the lines for any combinations that aren't relevant to the asset type than to

create new lines manually.

To copy the setup of fault symptoms, areas, and types from one asset type to the selected asset type, select CopyCopy

from asset typefrom asset type.

7. Select SaveSave to save your changes.



Create fault causes

Create fault remedies

Follow these steps to create a list of known fault causes that can be added to a work order or a maintenance

request.

1. Select Asset managementAsset management > SetupSetup > FaultFault > Fault causesFault causes .

2. Select NewNew  to create a record.

3. In the Fault causeFault cause field, enter a name for the fault cause.

4. In the Descr iptionDescr iption field, enter a description.

5. Select SaveSave.

Follow these steps to create a list of suggestions for remedy and repair that can be added to a work order or a

maintenance request.

1. Select Asset managementAsset management > SetupSetup > FaultFault > Fault remediesFault remedies .

2. Select NewNew  to create a record.

3. In the Fault remedyFault remedy  field, enter a name for the fault remedy.

4. In the Descr iptionDescr iption field, enter a description.

5. Select SaveSave.



NOTENOTE

NOTENOTE

You can change the names of your fault symptoms, areas, types, causes, and remedies as you require. The name changes

are automatically reflected in the related fault registrations.

Can you tell us about your documentation language preferences? Take a short survey.
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All work orders

Work orders are used to manage maintenance jobs, provide required information for them, and register

consumption on them. Each work order can contain one or more work order jobs, and one or more assets can

be connected to each work order. Each work order job defines a maintenance job that is scheduled on the asset.

Work orders can be created in the following ways:

For calendar-based maintenance plans where the "Auto create" setting is turned on, automatically by

using Schedule maintenance plans.

For maintenance rounds where the "Auto create" setting is turned on, automatically by using Schedule

maintenance rounds.

For preventive maintenance jobs or maintenance requests, from Maintenance schedule.

Manually

From the All maintenance requestsAll maintenance requests , Active maintenance requestsActive maintenance requests , or My functional locationMy functional location

maintenance requestsmaintenance requests  page.

Work order jobs that are related to the same asset are related to the same project ID.

Select Asset managementAsset management > CommonCommon > Work ordersWork orders  > All work ordersAll work orders  to open the All work ordersAll work orders  list

page. This page shows all work orders and some of the information that is related to each.

The illustration below shows an example of the All work ordersAll work orders  list page.

To view a list of only active work orders, select Asset managementAsset management > CommonCommon > Work ordersWork orders  > ActiveActive

work orderswork orders .

To view a list of work order jobs that contain assets that are installed on functional locations that you're related

to as a worker, select Asset managementAsset management > CommonCommon > Work ordersWork orders  > My functional location workMy functional location work

order maintenance jobsorder maintenance jobs . (The relation between workers and functional locations is set up on the WorkersWorkers

page. For more information, see Maintenance workers and worker groups.)
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Edit Edit the selected work order.

New Create new work order.

Delete Delete the selected work order.

Work order pool Add the selected work order to a work order pool, or
remove it from work order pool.

Adjust Adjust information about expected start and end, service
level, responsible maintenance worker, or responsible
maintenance worker group on selected work orders.

Related work order Create a new work order related to the selected work order
job. This is useful if you want to register primary and
secondary work orders.

Here are some ways that you can use the All work ordersAll work orders  page:

In the grid view, select a link in the Work orderWork order  column to show the details view for the selected record.

You can then select EditEdit to open the record for editing.

In the details view, you view detailed information that is related to the work order.

In the details view, select the L inesLines  tab to view details of the work order job, or select the HeaderHeader  tab to

view details of the work order.

Expand the Related informationRelated information pane on the right side of the page to view additional information that

is related to the selected work order.

The illustration below shows an example of the All work ordersAll work orders  details view.

The buttons on the Action Pane are organized on tabs. The following table briefly describes the buttons that are

related to Asset Management:



Copy work order Create a new work order that is based on an existing work
order.

Event history View the registration history for the work order.

Work order maintenance job notes Create a description on a work order, or insert notes or
remarks about it. First, select Add timestampAdd timestamp to add your
user name and a timestamp to the note. Notes are shown
on the DescriptionDescription tab on the Line detailsLine details  FastTab of the
Work orderWork order  page.

Tools Create a list of required tools on a work order. Tools are set
up as resources in Organization administrationOrganization administration >
ResourcesResources > ResourcesResources .

Maintenance checklist View the checklist for the asset that is connected to the work
order.

Asset fault View or register fault information on an asset. This
information is used for fault management.

Maintenance downtime Specify maintenance downtime for a work order.

Condition assessment Register condition assessment measurements on a work
order.

Asset counters Create or view counter registrations on the asset.

Forecast View or create forecasts on a work order.

Journals View or create work order journals. Journal lines can be
copied from forecasts.

Project transactions View all posted transactions that are related to work orders
created for the asset.

Update Work order state Update the work order lifecycle state.

Lifecycle state log View a log that shows the lifecycle states of the selected
work order.

Asset documents View the list of documents attached to assets that are
related to a work order. These documents are set up in
Asset managementAsset management  > SetupSetup > Asset documentsAsset documents .

Schedule Schedule the selected work orders.

Dispatch Schedule the selected work order for one worker.

Delete schedule Delete the scheduling for the selected work order.

Scheduled work order maintenance jobs Open the Scheduled work order maintenance jobsScheduled work order maintenance jobs list
page.
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Work order purchase requisition Open the Work order purchase requisitionWork order purchase requisition list page.

Work order purchase Open the Work order purchaseWork order purchase list page.

Cost control Compare budget costs and actual costs on the work order.

Hour control Compare forecasted hours and actual hours on the work
order.

Work order report Print a work order report.

Work order consumption Print a consumption report.
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NOTENOTE

The buttons in the ProjectProject group on the Work orderWork order  tab of the Action Pane are related to the functionality for

forecasts, journals, and invoicing in the Project management and accountingProject management and accounting module.

To include forecasts that have been created on a work order when you run master scheduling, use the forecast model that

is selected on the Asset management parametersAsset management parameters  page.
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Create work order

NOTENOTE

You can create work orders manually in two ways:

On the All work ordersAll work orders  or Active work ordersActive work orders  page

On the All maintenance requestsAll maintenance requests  or Active maintenance requestsActive maintenance requests  or My functional locationMy functional location

maintenance requestsmaintenance requests  page

1. Selece Asset managementAsset management > CommonCommon > Work ordersWork orders  > All work ordersAll work orders  or Active work ordersActive work orders .

2. Select NewNew .

3. In the Create work orderCreate work order  dialog, select a work order type in the Work order typeWork order type field.

4. If required, select a Descr iptionDescr iption.

5. In the AssetAsset field, select the asset.

When you select an asset, three tabs might be available in the AssetAsset  drop-down:

Active assetsActive assets  - This tab contains a list of all assets that have an "Active" asset lifecycle state.

Asset viewAsset view  - This tab displays a tree view of functional locations and the assets installed on them.

My assetsMy assets  - This tab contains assets that are related to the functional locations that you (the worker who is

signed in to the system) may be allocated to. (For information about the setup, see Maintenance workers and

worker groups.) If no functional locations are set up on a worker in Maintenance workers and worker groups,

the My assetsMy assets  tab isn't available.

6. In the Maintenance job typeMaintenance job type field, select a maintenance job type for the work order.

7. If required, select Maintenance job type var iantMaintenance job type var iant and TradeTrade.

8. If required, you can change the work order service level in the Ser vice levelSer vice level  field.

9. Select Expected star tExpected star t and Expected endExpected end dates in the related fields.

10. Click OKOK to create the work order.

11. On the All work ordersAll work orders  list page, you can edit the work order as you require.

Note the following points:

In the details view on the All work ordersAll work orders  list page, you can add several assets to a work order by

adding lines on the Work order maintenance jobsWork order maintenance jobs  FastTab. On an asset, you can select only the

maintenance job types that are defined on the asset type that is selected on the asset.

If you change an asset service level or an asset criticality after you've used the asset on a work order, the

service level or criticality on the work order isn't updated accordingly. For more information about

service levels and criticalities, see Asset service levels and Asset criticality types.
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Create related work order

Criticality on a work order is recalculated every time a work order job is added to or deleted from the

work order.

In the All work ordersAll work orders  details view > HeaderHeader  tab > ScheduleSchedule FastTab, in the Responsible groupResponsible group or

ResponsibleResponsible field, you can select a responsible maintenance worker group or a responsible maintenance

worker. These settings can be changed while the work order is active. For example, they can be changed

when the work order lifecycle state changes. The automatic selection that is made during work order

creation is based on the setup on the Responsible maintenance workersResponsible maintenance workers  page. If you add or remove

work order jobs after you've created a work order, and if the Responsible groupResponsible group and ResponsibleResponsible

fields are blank when you update the work order, Asset Management tries to find a responsible

maintenance worker group or a responsible maintenance worker for a possible match on the setup page.

If the Responsible groupResponsible group or ResponsibleResponsible field is already set when you update the work order, no

changes are made. For more information about responsible maintenance workers and worker groups,

see Responsible maintenance workers.

From the Maintenance status page, you can do a calculation to get an overview of the workload for

incoming and completed work orders.

In the details view of the All work ordersAll work orders  page, on the L ine detailsL ine details  FastTab, you can use the LatitudeLatitude

and LongitudeLongitude fields to add geographic coordinates for the asset that is selected on the work order job.

You can create a work order that is related to an existing work order. This capability is useful if, for example, you

want to work with primary and secondary work orders. A new work order is based on a work order job from an

existing work order.

1. Select Asset managementAsset management > CommonCommon > Work ordersWork orders  > All work ordersAll work orders  or Active work ordersActive work orders .

2. Select the work order to create a related work order for.

3. On the Action Pane, on the Work orderWork order  tab, in the NewNew  group, select Related work orderRelated work order .

4. In the Create related work orderCreate related work order  dialog, in the Work order jobWork order job field, select the work order job to

create a related work order for.

5. Select a maintenance job type in the Maintenance job typeMaintenance job type field.

6. Select a related maintenance job type variant and trade in the Maintenance job type var iantMaintenance job type var iant and

TradeTrade fields, as you require.

7. If this work order is the first related work order that has been created for the selected work order, follow

these steps:

a. Select the New work orderNew work order  option.

b. In the Work order typeWork order type field, select a work order type.

c. In the Descr iptionDescr iption, enter a description.

d. In the Ser vice levelSer vice level  field, change the work order service level as you require.

e. In the Expected star tExpected star t and Expected endExpected end fields, select the expected start and end dates.

f. Select OKOK. The new related work order is shown on the All work ordersAll work orders  list page.

8. If the work order that you're creating this related work order for already has related work orders, follow

these steps to add a new work order job to an existing related work order :

a. Select the Add to related work orderAdd to related work order  option.

b. In the Work orderWork order  field, select the related work order to add a new work order job to.

c. In the Ser vice levelSer vice level  field, change the work order service level as you require.
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Copy a work order

d. In the Expected star tExpected star t and Expected endExpected end fields, change the expected start and end dates as you

require.

e. Select OKOK. The work order job is added to the existing related work order.

The illustration below shows an example of the Create related work orderCreate related work order  dialog.

If you've set up a related work order mask in Asset management parametersAsset management parameters  > Work ordersWork orders  tab > Related workRelated work

order maskorder mask field, work order IDs are created according to the mask setup. If no related work order mask is set up, the

next available work order ID is used for related work orders.

You can quickly create a new work order from an existing work order. This way of working with work orders

differs from the creation of work orders based on maintenance plans. It's useful if, for example, a work order

contains many work order jobs, and the various jobs should be completed on different assets at regular

intervals.

1. Select Asset managementAsset management > CommonCommon > Work ordersWork orders  > All work ordersAll work orders  or Active work ordersActive work orders .

2. Select the work order to copy content from.

3. On the Action Pane > Work orderWork order  tab > NewNew  group, select Copy work orderCopy work order .

4. The work order setup from the selected work order is shown. You can edit some of the fields as you

require.

5. Select OKOK to create the new work order.

6. On the All work ordersAll work orders  list page, you can edit the work order as you require.
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Create a work order based on a maintenance request

When the new work order is created, some information is copied directly from the existing work order. Information about

forecasts, tools, maintenance checklists, functional location, addresses, and scheduling isn't copied. Instead, it's initialized

from the current setup in Asset Management. Therefore, if that information was changed between the time when the first

work order was created and the time when you made a copy of the work order, the changes are included in the new work

order. Examples include changes to forecasts and updates to maintenance checklists.

The illustration below shows an example of the Copy work orderCopy work order  dialog.

1. Select Asset managementAsset management > CommonCommon > Maintenance requestsMaintenance requests  > All maintenance requestsAll maintenance requests  or

Active maintenance requestsActive maintenance requests .

2. Select the maintenance request to create a work order for, and click EditEdit.

3. On the Action Pane > Maintenance requestMaintenance request tab > NewNew  group, select Work orderWork order .

4. In the Work orderWork order  dialog, set the fields. If a maintenance job type has been selected in the maintenance

request, you can select a different maintenance job type when you create the work order, as you require.

5. Select OKOK. A message notifies you that the work order has been created.

6. To view the work orders that are connected to a maintenance request, on the All maintenanceAll maintenance

requestsrequests  or Active maintenance requestsActive maintenance requests  list page, select the maintenance request. Then, on the

Action Pane, on the Maintenance requestMaintenance request tab, in the ViewView  group, select Work ordersWork orders .

The illustration below shows an example of the Create work orderCreate work order  dialog.
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If you want work orders to be created automatically, you can schedule maintenance plan jobs, or you can set up "Auto

create" maintenance plans or maintenance rounds on an asset. Work orders that are created from maintenance requests

on the All maintenance scheduleAll maintenance schedule list page have the maintenance job types that are selected on the maintenance

requests.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Add an hours forecast to a work order

Add an items forecast to a work order

When you create a work order, you create work order jobs that have related assets and maintenance job types.

When you select a maintenance job type that contains maintenance forecasts, the forecasts are automatically

copied to the work order.

You might be able to add forecast lines to a work order or delete them from a work order. The setup of the work

order lifecycle state, the related project type, and the stage rules that are related to the project type determine

whether you can add or edit forecast lines. For more information about work order lifecycle states and related

project stages, see Forecasts, work orders, and projects.

1. Select Asset managementAsset management > CommonCommon > Work ordersWork orders  > All work ordersAll work orders  or Active work ordersActive work orders .

2. Select the work order in the list, and then, on the Action Pane > Work orderWork order  tab > the ProjectProject group,

select ForecastForecast. The Work order maintenance forecastWork order maintenance forecast page shows forecast lines from the

maintenance job type that is selected on the work order job.

1. On the Work order maintenance forecastWork order maintenance forecast page, select the work order job to add a forecast to.

2. On the HoursHours  FastTab, select AddAdd to create a new line.

3. In the Categor yCategor y  field, select a category.

4. In the HoursHours  field, enter the number of forecasted hours.

5. In the L ine proper tyLine proper ty  field, select the type of charge that should be used on the line.

There are three ways to add items to a work order maintenance forecast. You can create lines for items (spare

parts) that aren't included on the spare parts list or the asset bill of materials (BOM), you can select spare parts

from the approved spare parts list, or you can select items from the asset BOM.

On the Work order maintenance forecastWork order maintenance forecast page, select the work order job to add a forecast to.

On the ItemsItems FastTab, add items to the maintenance forecast by using the appropriate method.

To create a line for a spare part that isn't on the spare parts list or the asset BOM, follow these steps:

1. Select AddAdd.

2. In the Item numberItem number  field, select the item.

3. In the Sales quantitySales quantity  field, enter the quantity.

4. In the UnitUnit field, select the unit of measure for the quantity.

5. In the Cost pr iceCost pr ice and CurrencyCurrency  fields, enter appropriate values.

6. In the L ine proper tyLine proper ty  field, select a line property.

7. To change the list of dimensions that is shown on the item lines, select Inventor yInventor y  > Display dimensionsDisplay dimensions ,

select the dimensions, and then set the Save setupSave setup option to YesYes .

To add a spare part from an approved spare parts list, follow these steps:

1. Select Add spare par tsAdd spare par ts .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/work-orders/maintenance-forecasts.md


Add an expense forecast to a work order

NOTENOTE

2. Select the spare part, and edit the related information as you require.

3. Select OKOK.

To add an item from the asset BOM, follow these steps:

1. Select Add BOM itemsAdd BOM items .

2. Select the item, and edit the related information as you require.

3. Select OKOK.

To get an overview that shows where the item on the selected line is used in relation to assets, maintenance job

type defaults, spare parts, and work orders in Asset Management, select Item where usedItem where used. For more

information about this overview, see Item where used.

1. On the Work order maintenance forecastWork order maintenance forecast page, select the work order job to add a forecast to.

2. On the ExpenseExpense FastTab, select AddAdd to create a line.

3. In the Categor yCategor y  field, select a category.

4. In the QuantityQuantity  field, enter the quantity.

5. In the Cost pr iceCost pr ice, Sales currencySales currency , and Sales pr iceSales pr ice fields, enter appropriate values.

6. In the L ine proper tyLine proper ty  field, select the type of charge that should be used on the line.

The Maintenance forecast totalsMaintenance forecast totals  FastTab shows an overview of the number of lines that have been created, for the

selected work order job and for the work order, on each FastTab. It also shows the total forecasted work hours for the

work order job and the work order.

The illustration below shows an example of the Work order maintenance forecastWork order maintenance forecast page.



Automatic update of work order forecasts
If hour costs, item costs, and expenses are updated in other modules in Microsoft Dynamics 365 for Finance and

Operations, work order forecasts in Asset Management can automatically be updated to reflect those changes.

This capability helps guarantee that the latest cost prices are always used in your work order forecasts. You can

also do similar updates for maintenance job type forecasts.

1. Select Asset managementAsset management > PeriodicPeriodic > ForecastForecast > Update work order forecastUpdate work order forecast.

2. In the Update work order forecastUpdate work order forecast dialog, on the Records to includeRecords to include FastTab, you can add selections

regarding specific work orders or work order jobs, as you require. Click FilterFilter  to make the relevant

selections.

3. On the Run in the backgroundRun in the background FastTab, you can set up the automatic update as a batch job, as you

require.

4. Select OKOK to start the forecast update.

The illustration below shows an example of the Update work order forecastUpdate work order forecast dialog.
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In Asset Management, you can get an overview of purchase requisitions and purchase orders that are related to

work orders. You can also create a purchase order or a purchase requisition from a work order.

The Work order purchase requisitionWork order purchase requisition list page (Asset managementAsset management > CommonCommon > ProcurementProcurement >

Work order purchase requisitionWork order purchase requisition) shows a list of purchase requisitions that are related to work orders.

When you select a work order job on this page, you can use the buttons in the ShowShow  group on the Work orderWork order

purchase requisitionpurchase requisition Action Pane tab to perform various actions:

To open the related purchase requisition, select Purchase requisitionPurchase requisition.

To open the related work order, select Work orderWork order .

To get an overview that shows where the item on the selected line is used in relation to assets, maintenance

job type defaults, spare parts, and work orders in Asset Management, select Item where usedItem where used. For more

information about this overview, see Item where used.

The illustration below shows an example of the Work order purchase requisitionWork order purchase requisition list page.

The Work order purchaseWork order purchase list page (Asset managementAsset management > CommonCommon > ProcurementProcurement > Work orderWork order

purchasepurchase) shows a list of purchase orders that are related to work orders. When you select a work order job on

this page, you can use the buttons in the ShowShow  group on the Work order purchaseWork order purchase tab of the Action Pane to

perform various actions:

To open the related purchase order, select Purchase orderPurchase order .

To open the related work order, select Work orderWork order .

To get an overview that shows where the item on the selected line is used in relation to assets, maintenance

job type defaults, spare parts, and work orders in Asset Management, select Item where usedItem where used. For more

information about this overview, see Item where used.

The illustration below shows an example of the Work order purchaseWork order purchase list page.
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Create a purchase order from a work order

On both the Work order purchaseWork order purchase list page and the Work order purchase requisitionWork order purchase requisition list page, a symbol

that is related to delivery date control appears on the right side of each line. If the symbol is an exclamation

point in a red circle, delivery of the related purchase order or purchase requisition might be delayed.

For a purchase order, the date that is related to the purchase order line is used to calculate a possible delay. To

view this date, on the Purchase orderPurchase order  page, select the purchase order line. The date is shown in the

Confirmed deliver y dateConfirmed deliver y date field on the SetupSetup tab of the L ine detailsL ine details  FastTab. If the Confirmed deliver yConfirmed deliver y

datedate field isn't set, the date in the Deliver y dateDeliver y date field on the Purchase order headerPurchase order header  FastTab is used for the

calculation. One of those dates is compared to the available date on the work order or work order job, in the

following order :

1. Actual start date on the work order

2. Scheduled start date on the related work order job

3. Scheduled start date on the work order

4. Expected start date on the work order

For a purchase requisition, the date in the Requested dateRequested date field on the Purchase requisition headerPurchase requisition header  FastTab

of the Purchase requisitionsPurchase requisitions  page is used to calculate a possible delay. The date in that field is compared to

the available date on the work order or work order job, in the same order that is used for a purchase order.

On the All work ordersAll work orders  list page, you can select a work order job, and then create a related purchase order or a

related purchase requisition. In this way, you help guarantee that project relations exist between the purchase

order or purchase requisition and the work order.

1. Select Asset managementAsset management > CommonCommon > Work ordersWork orders  > All work ordersAll work orders  or Active work ordersActive work orders .

2. Select the work order to create a purchase order for, and then select EditEdit.

3. On the Work order maintenance jobsWork order maintenance jobs  FastTab, select the work order job to create the purchase order

for.

4. Select Item tasksItem tasks  > Purchase order from work order jobPurchase order from work order job.

5. On the Project purchase ordersProject purchase orders  list page, click NewNew .

6. Create the purchase order.
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Project relation between work order and purchase order or purchase
requisition

To create a related purchase requisition, follow the same steps. However, select Item tasksItem tasks > Purchase requisitionPurchase requisition

from work order jobfrom work order job in step 4.

A purchase order line or purchase requisition line is related to a work order job via the work order project and

the related project activity number. When you create a purchase order or purchase requisition from a work

order job, the related project activity number is mandatory. If all the work order jobs in the related work order

have the same maintenance job type, the project activity number is automatically entered on the purchase order

or purchase requisition. If the work order jobs have different maintenance job types, you must manually enter

the project activity number on the purchase order or purchase requisition.

To view or enter the activity number that is related to a purchase order line, on the Work order purchaseWork order purchase list

page, select the purchase order record, and then, in the Purchase orderPurchase order  column, select the link for the purchase

order. You can find the Activity numberActivity number  field on the ProjectProject tab of the L ine detailsL ine details  FastTab.

The illustration below shows an example of the Purchase orderPurchase order  page, with focus on the Activity numberActivity number .
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Likewise, to view or enter the activity number that is related to a work order purchase requisition line, on the

Work order purchase requisitionWork order purchase requisition list page, select the purchase requisition record, and then, in the PurchasePurchase

requisitionrequisition column, select the link for the purchase requisition. You can find the Activity numberActivity number  field on the

ProjectProject tab of the L ine detailsL ine details  FastTab.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Counters are used to create registrations on an asset, such as registrations about the number of hours that the

asset has been in operation or the quantity that has been produced.

The counter type that is selected for a counter might be set to inherit counter values. In other words, the InheritInherit

asset counter valuesasset counter values  option is set to YesYes  on the GeneralGeneral  FastTab of the CountersCounters  page (AssetAsset

managementmanagement > SetupSetup > Asset typesAsset types  > CountersCounters ). In this case, when you create a new counter line of that

type, every child asset that uses the same counter type is automatically updated.

On the All assetsAll assets  page, you create hours or quantity counter registrations on an asset, based on your readings

on the asset.

1. Select Asset managementAsset management > CommonCommon > AssetsAssets  > All assetsAll assets .

2. Select the asset, and then, on the Action Pane, on the AssetAsset tab, in the PreventivePreventive group, select

CountersCounters . The Asset countersAsset counters  page shows a list of all previous counter registrations that have been

made on the selected asset.

3. Select NewNew  to create a registration. The asset ID is automatically entered in the AssetAsset field.

4. In the CounterCounter  field, select the relevant counter. Only counters that are related to the asset type selected

on the asset are available for selection. The related unit is automatically entered in the UnitUnit field.

5. In the RegisteredRegistered field, select the date and time for the counter registration.

6. In the ValueValue field, enter the number since the last counter registration. Alternatively, in the AggregatedAggregated

valuevalue field, enter the total count number.

Note the following points:

If you physically install a new counter on an asset, you must register the change on the asset on the

Asset countersAsset counters  page. Next, you must create two registration lines that have identical timestamps. The

first line must be for the counter that you're replacing. On the line that is related to the new counter, select

the Counter resetCounter reset check box. In the TotalsTotals  field, the total count number is the sum of the counter totals

of all registered values on that counter type.

If the Counter resetCounter reset check box is selected on an asset using a maintenance plan that has a "Once from..."

or "Once reached..." interval type, the counter is still active on the new counter line, because you create a

separate counter line and start over with a new counter.

The illustration below shows an example of the Asset countersAsset counters  page.

On the Asset countersAsset counters  page (Asset managementAsset management > Inquir iesInquir ies  > AssetsAssets  > Asset countersAsset counters ), you can make
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counter registrations on several assets at the same time, as you require.

You can set up a range to define deviations in manual counter registrations. You can also specify the type of message that

is shown if registrations are outside the defined range. For more information about how to set up counters, see Counters.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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For information about manual registration of asset counters, see Manual update of asset counters. For

information on how to set up asset counters, see Counters.

Counter values can also be automatically updated from production registrations, based on the production hours

or production quantity (that is, the quantity that is produced). This update is done on the Update assetUpdate asset

counterscounters  page. You can update one or several assets by setting one parameter, From dateFrom date. This parameter

specifies the start date for production registrations (production hours or production quantities). In other words,

it specifies the date that counter values should be updated from.

All assets that are related to a resource, and that have asset counters that are set up to be updated based on the

production hours or production quantity, will be included in an automatic update. New counter values will be

created.

For counters that are based on the production quantity, the count includes both the good quantity and the error

quantity that are registered. If the unit that is used for production quantity registration differs from the unit that

is used for the counter, the quantity is converted so that it corresponds to the counter unit.

As mentioned above, automatic counters can be updated from production registrations. Therefore, the asset for

which you want to automatically update counters must be related to a resource (machine). When produced

quantities or production hours have been registered on the resource, you can update the related asset counters.

NOTENOTE

1. Select Asset managementAsset management > PeriodicPeriodic > AssetsAssets  > Update asset countersUpdate asset counters .

2. In the From dateFrom date field, select the start date of the automatic update.

The date in this field is the "work in progress" date from Route transactionsRoute transactions (Production controlProduction control > InquiriesInquiries

and repor tsand repor ts  > ProductionProduction > Route transactionsRoute transactions > Physical datePhysical date field).

3. On the Records to includeRecords to include FastTab, you can select specific assets, asset types, or resources for the

automatic update. Select FilterFilter , and make the relevant selections.

4. On the Run in the backgroundRun in the background FastTab, you can set up the automatic update as a batch job, as you

require.

The illustration below shows an example of the Update asset countersUpdate asset counters  dialog.

5. Select OKOK.
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After the automatic asset counter update is done, you can view the counter registrations that are related to the

asset on the Asset countersAsset counters  page. Select Asset managementAsset management > CommonCommon > AssetsAssets  > All assetsAll assets , select the

asset, and then, on the Action Pane, on the AssetAsset tab, in the PreventivePreventive group, select CountersCounters .

On the Asset aggregated valueAsset aggregated value page, you can get an overview of the latest registration that have been made

on all counter types on all assets. Select Asset managementAsset management > Inquir iesInquir ies  > AssetsAssets  > Asset aggregatedAsset aggregated

valuevalue. This page resembles the Asset countersAsset counters  page, but you can't add or edit registrations. It's for overview

only.

The illustration below shows an example of the Asset aggregated valueAsset aggregated value page.

Note the following points:

You can still create manual counter value registrations for counter types that are automatically updated.

For more information, see Manual update of asset counters.

You can set up counters that are related to another counter. In this case, when a counter is updated,

related counters are automatically updated at the same time. For more information about how to set up

related counters, see Counters.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Fill in a maintenance checklist

NOTENOTE

Add a maintenance checklist line

Maintenance checklists are set up on maintenance job types. You fill in maintenance checklists as part of the

process of completing a work order. For more information about how to set up maintenance checklists on

maintenance job types on the Maintenance job type defaultsMaintenance job type defaults  page, see Maintenance job type categories and

maintenance job types, maintenance job type variants, maintenance job trades, and maintenance checklists.

When you work with maintenance checklists on a work order, you can fill in the predefined maintenance

checklists that are related to maintenance job types. You can also add more maintenance checklists.

1. Click Asset managementAsset management > CommonCommon > Work ordersWork orders  > All work ordersAll work orders  or Active work ordersActive work orders .

2. Select the work order and then, on the Action Pane, on the Work orderWork order  tab, in the L inesLines  group, select

Maintenance checklistMaintenance checklist.

3. The Work order maintenance job checklistWork order maintenance job checklist shows the checklists for all work order jobs. If the work

order jobs have different maintenance job types, the maintenance checklists might differ for each work

order job. Select a work order job to work with the related maintenance checklist. Details of the selected

maintenance checklist line are shown on the L ine detailsL ine details  FastTab.

4. Complete all the maintenance checklist lines, one at a time, in the order that they appear in. You complete

a maintenance checklist line by filling in the fields on the L ine detailsL ine details  FastTab. The information that is

required to complete a line can vary, depending on the line type. For example, on a line of the TextText type,

you add a note that explains the result of your check. On a line of the MeasurementMeasurement type, you enter the

counter value that you read on the equipment, and you can also add a note as you require. A

maintenance checklist line of the HeaderHeader  type is used as a heading to group the maintenance checklist

lines that appear below it. You don't have to fill in a header. As for all other types of maintenance checklist

lines, you can add a note to a line of the HeaderHeader  type.

5. If instructions are related to a maintenance checklist line, the InstructionsInstructions  check box is selected. Read

instructions for the selected maintenance checklist line in the InstructionsInstructions  field on the L ine detailsL ine details

FastTab.

6. When you've completed a maintenance checklist line, select the CheckedChecked check box on that line to mark

it as completed. To discard a maintenance checklist line because it isn't relevant to the work order job,

select the N/AN/A check box on the line. If the Mandator yMandator y  check box is selected on a maintenance checklist

line, you must select either the CheckedChecked check box or the N/AN/A check box.

You can only update maintenance checklist registrations if the work order is in an Active lifecycle state.

Maintenance checklists are created from the definition on the maintenance job type default and are transferred

to a work order job. As you require, you can add maintenance checklist lines to a work order job. Maintenance

checklist lines that you manually add get the ManualManual  reference.
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1. On the Work order maintenance job checklistWork order maintenance job checklist page, select the work order job to add a maintenance

checklist for.

2. On the Maintenance checklist linesMaintenance checklist lines  FastTab, select a maintenance checklist line. Then, to insert a new

line after the selected line, press the Down arrowDown arrow  key. The next number in the sequence is automatically

entered in the L ine numberLine number  field. To insert a new line before the selected line, select Add lineAdd line.

3. On the NameName field, enter a name for the maintenance checklist line.

4. In the TypeType field, select a type for the maintenance checklist line. The L ine detailsL ine details  FastTab contains

related fields for each maintenance checklist type.

TextText - Use this type to add a maintenance checklist line that has text that describes what must be done.

For example, you can use this type if you want a worker to check or inspect something, but you aren't

expecting a specific (measurable) result. After you select this type, on the L ines detailsL ines details  FastTab, in the

InstructionsInstructions  field, enter text that describes what must be done.

HeaderHeader  - A maintenance checklist line of this type is used as a heading to group the maintenance

checklist lines that appear below it. This type is useful if you have several maintenance checklist lines

that can be divided into specific areas. After you select this type, in the NameName field, enter a descriptive

name.

TemplateTemplate - This type isn't applicable when you manually add a maintenance checklist line on a work

order job.

VariableVariable - Use this type to define a possible result in a range on the maintenance checklist line. For

information about how to set up maintenance checklist variables, see Maintenance job type categories

and maintenance job types, maintenance job type variants, maintenance job trades, and maintenance

checklists. After you select this type, in the NameName field, enter a name to describe the variable. On the

Line detailsL ine details  FastTab, in the VariableVariable field, select the variable. In the InstructionsInstructions  field, enter text that

describes what must be done.

MeasurementMeasurement - Use this type to record a specific measurement on the maintenance checklist line.

After you select this type, in the NameName field, enter a name for the measurement. On the L ine detailsL ine details

FastTab, in the CounterCounter  and UnitUnit fields, select appropriate values. In the InstructionsInstructions  field, enter text

that describes what must be done.

5. When you've finished manually adding maintenance checklist lines, fill in the lines as described in the FillFill

in a maintenance checklistin a maintenance checklist section above.

On the Work order maintenance job checklistWork order maintenance job checklist  page, you can't delete maintenance checklist lines that have the JobJob

typetype reference. You can delete only maintenance checklist lines that you or other maintenance workers have manually

created, and that have the ManualManual reference.

The illustration below shows an example of a maintenance checklist.
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Create maintenance downtime reason codes

Create maintenance downtime registrations

You can create maintenance downtime registrations on the asset that is selected on a work order. This capability

is useful if you want to register maintenance downtime on one or more machines in the production area. You

first create the maintenance downtime reason codes that you want to use, such as BreakdownBreakdown and PlannedPlanned

stopstop. This step is done on the Maintenance downtime reason codesMaintenance downtime reason codes  page. You can then create maintenance

downtime registrations on the Maintenance downtimeMaintenance downtime page and add the relevant maintenance downtime

reason codes.

1. Select Asset managementAsset management > SetupSetup > Work ordersWork orders  > Maintenance downtime reason codesMaintenance downtime reason codes .

2. Select NewNew .

3. In the Maintenance downtime reason codeMaintenance downtime reason code field, enter an ID for the maintenance downtime reason

code.

4. In the NameName field, enter a name.

5. Select the KPI includeKPI include check box if the reason code should be included in calculations of key

performance indicators (KPIs) for the asset. In general, planned production stops should not be included

in KPI calculations, because they don't affect expected performance.

6. Select SaveSave.

The illustration below shows an example of the Maintenance downtime reason codesMaintenance downtime reason codes  page.

After you've created the maintenance downtime reason codes that you want to use, you can create maintenance

downtime registrations for work orders and assets.

1. Click Asset managementAsset management > CommonCommon > Work ordersWork orders  > All work ordersAll work orders  or Active work ordersActive work orders .

2. Select the work order, and then, on the Work orderWork order  tab, in the AssetAsset group, select MaintenanceMaintenance

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/work-orders/maintenance-downtime.md


NOTENOTE

downtimedowntime.

3. Select NewNew .

4. In the FromFrom and ToTo fields, define the date and time interval for the maintenance downtime registration.

When you leave the ToTo field, the duration in hours is automatically inserted in the DurationDuration field.

5. In the maintenance downtime reason codemaintenance downtime reason code field, select a reason code.

6. Repeat steps 3 through 5 to add more registrations.

7. Select SaveSave.

The illustration below shows an example of maintenance downtime registration.

The calendar that is used to calculate a maintenance downtime registration depends on your selection in the

setup of assets and parameters. If a resource is selected on an asset in the ResourceResource field on the Fixed assetFixed asset

FastTab of the All assetsAll assets  page, the calendar that is set up for the associated resource group is used, as shown in

the following illustration.



If no resource is selected on the asset, the standard calendar that is selected on the Asset managementAsset management

parametersparameters  page is used, as shown in the following illustration.

To see an overview of all maintenance downtime registrations, click Asset managementAsset management > Inquir iesInquir ies  >

Maintenance downtimeMaintenance downtime.



NOTENOTE

NOTENOTE

All calendars that are used in the Asset ManagementAsset Management  module are set up in Organization administrationOrganization administration > SetupSetup >

CalendarsCalendars > CalendarsCalendars .

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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You can add faults that were set up in the fault designer to a work order. One or more fault records must be

connected to the asset types that are used for the asset that is selected in the work order. For more information

about the setup, see Fault management.

1. Select Asset managementAsset management > CommonCommon > Work ordersWork orders  > All Work ordersAll Work orders  or Active work ordersActive work orders .

2. Select the work order to make a fault registration on, and then, on the Action Pane, on the Work orderWork order

tab, in the AssetAsset group, select Asset faultAsset fault.

3. On the SymptomsSymptoms FastTab, select Add lineAdd line. A sequential fault number is automatically entered in the

FaultFault field.

4. In the Fault symptomFault symptom field, select the relevant symptom.

5. In the Fault areaFault area and Fault typeFault type fields, select the appropriate values.

6. In the Fault dateFault date field, the current date is automatically inserted. You can select a different date as you

require.

7. On the Causes for selected symptomCauses for selected symptom FastTab, add a line to describe the cause of the issue.

8. On the Remedies for selected symptomRemedies for selected symptom FastTab, add a line to describe a possible solution to the issue.

9. Select SaveSave.

The illustration below shows an example of a fault registration.
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View asset faults

Print asset fault report

In the Asset faultsAsset faults  list, you can get an overview of all faults registered on assets.

On the Asset faultsAsset faults  list page, you can get an overview of all faults that have been registered on assets. To open

the page, select Asset managementAsset management > Inquir iesInquir ies  > Asset faultAsset fault > Asset faultsAsset faults .

From the All assetsAll assets  list page, you can print an asset fault report that shows all fault registrations and a

graphical overview of fault statistics.

1. Select Asset managementAsset management > CommonCommon > AssetsAssets  > All assetsAll assets .

2. Select the asset to print a fault report for.

3. On the Action Pane, on the GeneralGeneral  tab, in the Repor tsRepor ts  group, select Asset faultAsset fault.

4. Enter a specific period, or select a fault type.

5. Select OKOK to print the report.



NOTENOTE

NOTENOTE

To print a fault report for several assets or asset types, select Asset managementAsset management  > Repor tsRepor ts  > AssetsAssets  > Asset faultAsset fault .

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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You can generate a work order report that shows detailed information about one or more work orders that you

select.

1. Select Asset managementAsset management > Repor tsRepor ts  > Work ordersWork orders  > Work order repor tWork order repor t.

2. Select "Yes"/"No" on the toggle buttons as you require, to determine the details to be included in the

report.

In the Pr int settingsPrint settings  section, you can select whether to include attachments from the setup of the

related maintenance job type.

3. On the Records to includeRecords to include FastTab, you can filter the contents of the report by Work orderWork order .

4. On the Run in the backgroundRun in the background FastTab, you can set up generation of the work order report as a batch

job, as you require.

5. Select OKOK to generate the report.

The following illustration shows an example of how the report parameters can be set up.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/work-orders/work-order-report.md


The following illustration shows an example of a work order report that is generated based on that setup.
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Create a work order pool

You can use work order pools to group work orders that have something in common. Here are some examples

of things that you can create work order pools for :

Work crews, for example, Maintenance Crew A or Maintenance Crew B

Professional skills, such as electricians or plumbers

Physical locations

Time schedules, such as weeks or other periods

As you require, you can put one work order in multiple work order pools.

On the All work order poolsAll work order pools  or Active work order poolsActive work order pools  list page, you can get an overview of your work

order pools and create new pools.

1. Select Asset managementAsset management > CommonCommon > Work order poolsWork order pools  > All work order poolsAll work order pools  or ActiveActive

work order poolswork order pools .

2. Select NewNew .

3. In the PoolPool  field, enter an ID for the work order pool.

4. the NameName field, enter a name.

5. Set the ActiveActive option to YesYes  to indicate that the work order pool is active.

6. Set the Delete work order relationsDelete work order relations  option to YesYes  if work orders should automatically be removed

from the work order pool.

7. In the Delete lifecycle stateDelete lifecycle state field, select the work order lifecycle state. For example, the work order

lifecycle state for completing a work order could be set to automatically delete relations to work order

pools.

You can start adding work orders to your work order pool right away.

8. On the Work ordersWork orders  FastTab, select Add lineAdd line.

9. In the Work orderWork order  field, select a work order. The related fields are automatically updated.

10. Repeat steps 8 through 9 to add more work orders.

11. If the work orders that you added should be done in a specific order, in the Sor t orderSor t order  field, you can

enter the numbers 11 , 22 , 33 , and so on, to specify that order.

12. To view a list of all the work orders that are included in the work order pool, on the Action Pane, on the

Work order poolWork order pool  tab, in the View work order pool relatedView work order pool related group, select Work ordersWork orders  to open the

All work ordersAll work orders  list page.

13. To calculate and view capacity load for the maintenance schedule, unscheduled work orders, and

scheduled work orders, on the Action Pane, on the Work order poolWork order pool  tab, in the View work order poolView work order pool

relatedrelated group, select Capacity loadCapacity load to open the Calculate capacity loadCalculate capacity load dialog.
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NOTENOTE

Add a work order to a work order pool

14. To calculate and view forecasts for items (spare parts and other required items) that are related to

maintenance schedule, unscheduled work orders, and scheduled work orders, on the Action Pane, on the

Work order poolWork order pool  tab, in the View work order pool relatedView work order pool related group, select Item forecastItem forecast to open the

Calculate item forecastCalculate item forecast dialog.

15. To view a list of purchase requisitions that are related to the work orders in the work order pool, on the

Action Pane, on the Work order poolWork order pool  tab, in the ProcurementProcurement group, select Work order purchaseWork order purchase

requisitionrequisition to open the Work order purchase requisitionWork order purchase requisition list page.

16. To view a list of purchase orders that are related to the work orders in the work order pool, on the Action

Pane, on the Work order poolWork order pool  tab, in the ProcurementProcurement group, select Work order purchaseWork order purchase to open

the Work order purchaseWork order purchase list page.

When a work order pool is no longer relevant to your work planning, set the ActiveActive option for that pool to NoNo in the list

view of the Work order poolWork order pool page.

To delete all worker order lines, set the Delete work order relationsDelete work order relations  option to YesYes . This option is useful if, for

example, you want to create an empty pool that you can use later for other work orders. When you're ready to

use the work order pool to create new work order relations later, remember to set the Delete work orderDelete work order

relationsrelations  option to NoNo.

The illustration below shows an example of the Work order poolWork order pool  list page.

As described in the previous section, you can add work orders to a work order pool when you create that pool.

You can also add work orders to a work order pool on the All work ordersAll work orders  or Active work ordersActive work orders  list page.

1. Select the work order, and then, on the Action Pane, on the Work orderWork order  tab, in the MaintainMaintain group,

select Work order poolWork order pool .

2. Select the work order in the list, and click Work order poolWork order pool .

3. In the Maintain work order poolMaintain work order pool  dialog, in the Add/removeAdd/remove field, select AddAdd.

4. In the PoolPool  field, select the work order pool.

5. Select OKOK.



NOTENOTE

6. To put the work order that you added in a specific order in the work order pool, on the All work orderAll work order

poolspools  or Active work order poolsActive work order pools  list page, select the pool, and then select EditEdit. Then, on the WorkWork

order poolorder pool  page, on the Work ordersWork orders  FastTab, use the Sor t orderSor t order  field to adjust the sort order of the

work orders that are included in pool.

To remove a work order from a work order pool, repeat these steps, but select RemoveRemove in step 3.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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On the Active work order maintenance jobsActive work order maintenance jobs  list page, you can get an overview of work orders, in terms of

the number of work orders that have been created on specific assets, asset types, manufacturers, models,

maintenance job types, and so on. By selecting a work order job and then selecting EditEdit, you can open the

related work order. By selecting a work order job and then selecting one of the buttons on the Work orderWork order

maintenance jobsmaintenance jobs  tab of the Action Pane, you can view data for the work order that the work order job is

related to.

To open the list page, select Asset managementAsset management > CommonCommon > Work ordersWork orders  > Active work orderActive work order

maintenance jobsmaintenance jobs . The page lists all active work order jobs, and it also shows some of the information that is

related to the work order or work order job.

In the %% column, a number shows completion of the work order as a percentage. Completion is based on two

calculations: posted hours compared to forecasted hours, and the number of maintenance checklists that have

been completed.

The illustration below shows an example of the Active work order maintenance jobsActive work order maintenance jobs  list page.

For a short description of the buttons on the Active work order maintenance jobsActive work order maintenance jobs  list page, refer to

Introduction to work orders where identical buttons are described.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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In Asset Management, assets can be related to fixed assets, and you can create work orders for those assets. If

you use this functionality, you can get a complete overview of fixed assets, related investment projects, and the

costs that are registered on the investment projects in the Project management and accountingProject management and accounting and FixedFixed

assetsassets  modules in Microsoft Dynamics 365 for Finance and Operations.

The Fixed asset numberFixed asset number  field on the work order job project is set only if InvestmentInvestment  is selected as the project type on

the work order job project.

The illustration below shows the relation between an investment project in the Project management andProject management and

accountingaccounting module and a work order job project.

The following procedure describes the relation between assets, work orders, work order job projects, and fixed

assets.

1. You create an asset that you relate to a fixed asset.
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2. When you set up work order types on the Work order typesWork order types  page (Asset managementAsset management > SetupSetup > WorkWork

ordersorders  > Work order typesWork order types ), you create a work order type for handling investments. See also Work order

types.

3. When you set up work order project groups on the Project groupProject group tab of the Work order project setupWork order project setup

page (Asset managementAsset management > SetupSetup > Work ordersWork orders  > Project setupProject setup), you create a relation between the

work order type that is used for investments and the project group that was created for investments on the

Project groupsProject groups  page in the Project management and accountingProject management and accounting module (Project management andProject management and

accountingaccounting > SetupSetup > PostingPosting > Project groupsProject groups ).



4. When you create a work order that is related to a fixed asset, you select the work order type that is used

to handle investments, such as InvestmentInvestment.

5. When the work order is created, the related work order type is shown on the All work ordersAll work orders  page.

6. When the work order is created, the project that is related to the work order is created on the All projectsAll projects

page in the Project management and accountingProject management and accounting module (Project management and accountingProject management and accounting >

ProjectsProjects  > All projectsAll projects ). To view project-related information, select the link in the Project IDProject ID field on the

GeneralGeneral  tab on the L ine detailsL ine details  FastTab in the details view of the All work ordersAll work orders  page in the AssetAsset

managementmanagement module (Asset managementAsset management > CommomCommom > Work ordersWork orders  > All work ordersAll work orders ).



NOTENOTE

7. To see an overview of the projects associated with a fixed asset, select Fixed assetsFixed assets  > Fixed assetsFixed assets  > FixedFixed

assetsassets , and then, in the Fixed asset numberFixed asset number  field, select the link for the fixed asset to open the details view.

Expand the Related informationRelated information pane on the right side of the page, and select the Associated projectsAssociated projects

FastTab.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Forecasts, work orders, and projects
2/18/2021 • 5 minutes to read • Edit Online

Work order job projects

In Asset Management, integration with the Project management and accountingProject management and accounting module helps optimize

cost control, so that users can track costs on maintenance job type forecasts and work order jobs.

Tracking of maintenance job type forecasts requires two settings:

1. Select a project in Asset managementAsset management > SetupSetup > Asset management parametersAsset management parameters , and then, on the

AssetsAssets  tab > on the ProjectProject FastTab, in the Maintenance forecast projectMaintenance forecast project field, select a project.

2. When you create a maintenance job type default line, an activity number is automatically created for the

line on the Maintenance job type defaultsMaintenance job type defaults  page (Asset managementAsset management > SetupSetup > JobsJobs  >

Maintenance job type defaultsMaintenance job type defaults ).

Maintenance job type forecasts serve two purposes:

You can track costs on maintenance job type forecasts in the Project management and accountingProject management and accounting

module.

Forecasts are automatically transferred to a work order job project when you select a maintenance job type

on a work order job.

To track costs on work order jobs, you must first set up work order projects. For more information, see Work

order project setup.

When you create a work order job on a work order, the work order project is determined by the setup of the

parent project for work orders on the Work order project setupWork order project setup page (Asset managementAsset management > SetupSetup >

Work ordersWork orders  > Project setupProject setup).

Work order job projects are created by using a combination of the following work order information:

The work order type selected on the work order

The functional location related to the asset on the work order job

The asset type that is related to the asset on the work order job

The expected start and end times that are set on the work order

Some of this information might not be found on a work order. Therefore, the search for a work order parent

project is done by using the available combination of data and selecting the project ID that corresponds to work

order data.

For example, in the following illustration, because of the way that the Truck EngineTruck Engine asset type is set up, every

work order job that is created with the Truck EngineTruck Engine asset type will be a sub-project of project ID 000186.
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The purpose of the project ID on the work order job, and the related activity number, is to track costs that are

related to the work order job, and the asset that is selected on it, in the Project management and accountingProject management and accounting

module. (To view the project ID and activity number, select Asset managementAsset management > CommonCommon > Work ordersWork orders  >

All work ordersAll work orders , and then select the work order. On the L ine detailsL ine details  FastTab, the Project IDProject ID field shows the

project ID, and the Activity numberActivity number  field shows the activity number.) For more information about cost control

in Asset Management, see Cost and date control.

The following illustration shows a graphical overview of work order projects and related project activities.



When a new work order job is created on a work order, a work order project is automatically created for the job.

The financial dimensions for the asset that is related to the work order job are automatically transferred to the

work order project.

The project activity that is created for a work order job has related information attached to it. This information is

about the maintenance job type, maintenance job type variant, and trade. It's useful if, for example, you create a

purchase order from a work order (see Procurement), or if you use the Project management andProject management and

accountingaccounting module for time registration.

If the asset was installed on a functional location but is later installed on a different functional location, the

financial dimensions that are related to the new functional location are automatically updated on the asset. Then,

when you create a work order job for the asset, the work order project for the work order job automatically gets

the financial dimensions that are now related to the asset. Therefore, when you use functional locations, costs

can always be tracked on the functional locations that an asset was installed on at any given time. The automatic

update of financial dimensions helps guarantee complete traceability of costs for project control and reporting.



Work order projects, work order lifecycle states, project stages, and
project types
To help guarantee that work order lifecycle states and related project stages on work orders are used correctly,

consider the dependencies in relation to the Project management and accountingProject management and accounting module:

In the Project management and accountingProject management and accounting module, project stages are set up on project types on the

Project management and accounting parametersProject management and accounting parameters  page.

On the Project management and accounting parametersProject management and accounting parameters  page, use the check boxes to select relevant

project stages for all the project types that you will use. In the following illustrations, five stages (CreatedCreated,

EstimatedEstimated, ScheduledScheduled, In processIn process , and FinishedFinished) have been selected for the Time and mater ialTime and mater ial  and

InternalInternal  project types. Those five stages are relevant to both internal maintenance jobs and service

maintenance jobs.

In the Asset ManagementAsset Management module, project types are defined by the project groups that you set up on the

Work order project setupWork order project setup page > Project groupProject group tab (Asset managementAsset management > SetupSetup > Work ordersWork orders  >

Project setupProject setup).

The project groups that are set up on the Work order project setupWork order project setup page are used when you create work

orders. When a work order is created, a work order project is automatically created for the work order.

Every work order lifecycle state must have a related project stage.

The project stage that is related to a work order lifecycle state must be defined as an active stage for the

project group that is defined in the work order project. The work order project is automatically created on a

work order.

When you create a new work order, the automatic allocation of a work order project is based on the setup on

the Work order project setupWork order project setup page.

The following illustrations show the associations between work order project groups, related project types,

project stages, and work order lifecycle states.



For information about how to set up work order projects, see Work order project setup. For information about

how to create work order lifecycle states, see Work order lifecycle states.

The following illustration shows a graphical overview of the various projects that are created in the AssetAsset

managementmanagement module to enable integration with the Project management and accountingProject management and accounting module. It also

shows the work processes that the projects are related to.
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Turn on the customer billing feature

Example scenario

Step 1: Create a new project contract for the customerStep 1: Create a new project contract for the customer

Step 2: Create a new parent project for the customerStep 2: Create a new parent project for the customer

The Work order billing feature lets you create, process, and bill maintenance work that is done on assets that

your customers own. This feature lets you perform the following tasks:

Connect customers to the assets that they own.

Select a customer and view the assets that customer owns when you create a work order.

Set up a parent project for each customer.

Register hours, items, expenses, and fees against the work order, and then create an invoice proposal for the

customer later.

In addition, the feature provides the following functionality:

The project contract from a customer's parent project is automatically copied to the relevant work order

project.

Asset management can now use the fee project transaction type on both work order forecasts and work

order journals.

Before you can use this feature, it must be turned on in your system. Admins can use the feature management

settings to check the status of the feature and turn it on. In the Feature managementFeature management workspace, the feature is

listed in the following way:

Module:Module: Project management and accounting

Feature name:Feature name: Work order billing

To learn how this feature works, work through the following example scenario.

To work through this scenario by using the sample records and values that are specified here, you must be on a

system where the standard demo data is installed. You must select the USMFUSMF legal entity before you begin.

You can also use this scenario as guidance for using the feature when you work on a production system.

However, in that case, you must substitute your own values, and you might be missing some types of required

records that the standard demo data provides.

1. Go to Project management and accounting > Projects > Project contractsProject management and accounting > Projects > Project contracts .

2. On the Action Pane, select NewNew .

3. In the New project contractNew project contract dialog box, set the following values:

Name:Name: Pelican Wholesales

Funding type:Funding type: Customer

Funding source:Funding source: US-013 (Pelican Wholesales)

4. Select OKOK.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/integration-to-project-management-and-accounting/customer-billing.md


Step 3: Create a new work order type in Asset managementStep 3: Create a new work order type in Asset management

Step 4: Link the customer account to the parent projectStep 4: Link the customer account to the parent project

Step 5: Link the project group and type to the work order projectStep 5: Link the project group and type to the work order project

NOTENOTE

Step 6: Link an asset to the customer IDStep 6: Link an asset to the customer ID

The parent project that you create here will be used when work orders for the customer are created.

1. Go to Project management and accounting > Projects > All projectsProject management and accounting > Projects > All projects .

2. On the Action Pane, select NewNew .

3. In the New projectNew project dialog box, set the following values:

Project type:Project type: Time and material

Project name:Project name: Pelican Wholesales work orders

Project group:Project group: TM

Project contract ID:Project contract ID: Pelican Wholesales (the contract that you created earlier)

Star t date:Star t date: Select today's date.

4. Select Create projectCreate project.

5. The new project is opened. Make a note of the Project IDProject ID value. You will have to enter it later.

1. Go to Asset management > Setup > Work order > Work order typesAsset management > Setup > Work order > Work order types .

2. On the Action Pane, select NewNew .

3. A new record is added to the list. Set the following values for it:

Work order type:Work order type: Service

Name:Name: Service work orders

Work order lifecycle state:Work order lifecycle state: Standard

You must now link the customer account to the parent project in the project setup in Asset management.

1. Go to Asset management > Setup > Work orders > Project setupAsset management > Setup > Work orders > Project setup.

2. On the Parent projectParent project tab, select AddAdd to add a line.

3. On the new line, set the following values:

Customer account:Customer account: US-013 (Pelican Wholesales)

Project ID:Project ID: Enter the project ID that you made a note of earlier.

You should still be on the Project setupProject setup page (Asset management > Setup > Work orders > ProjectAsset management > Setup > Work orders > Project

setupsetup).

1. On the Project groupProject group tab, select AddAdd to add a line.

2. On the new line, set the following values:

Work order type:Work order type: Service (the work order type that you created earlier)

Project group:Project group: TM

The project contract on the work order project is always inherited from the parent project.

1. Go to Asset management > Assets > Active assetsAsset management > Assets > Active assets .



Step 7: Create a new work order on the assetStep 7: Create a new work order on the asset

Step 8: Review the work order and start to work on itStep 8: Review the work order and start to work on it

Step 9: Post the hours that were spent on the work order and create a new invoice proposalStep 9: Post the hours that were spent on the work order and create a new invoice proposal

2. In the FilterFilter  field, enter VE-102, and select to filter by AssetAsset.

3. Select the asset to open its settings.

4. On the CustomerCustomer  FastTab, set the Customer accountCustomer account field to US-013 (Pelican Wholesales).

The NameName field is automatically updated to Pelican Wholesales.

1. Go to Asset management > Work orders > Active work ordersAsset management > Work orders > Active work orders .

2. On the Action Pane, select NewNew .

3. In the Create work orderCreate work order  dialog box, set the following values:

NOTENOTE

Work order type:Work order type: Service

Descr iption:Descr iption: Repair Truck

Customer account:Customer account: US-013 (Pelican Wholesales)

Asset:Asset: VE-102

The lookup shows only assets that are linked to the selected customer account.

Maintenance job type:Maintenance job type: Repair

Trade:Trade: Mechanic

Ser vice level:Ser vice level: 4

4. Select OKOK.

In this section, you will work on the work order that you created in the previous section.

1. Follow these steps to verify that the parent project is the Pelican wholesales Work order project:

a. In the Work order maintenance jobsWork order maintenance jobs  section, select a line.

b. On the L ine detailsL ine details  FastTab, inspect the Project IDProject ID value. It should be a hyphenated number in the

form <Parent-Project-ID>-<Project-ID>. This value is a link.

c. Select the project ID link to open a page where you can view the parent project and project names.

2. On the Action Pane, on the Work orderWork order  tab, in the L ifecycle stateLifecycle state group, select Update work orderUpdate work order

statestate.

3. In the Update work order stateUpdate work order state dialog box, in the SelectSelect column, select the check box for the row

where the L ifecycle stateLifecycle state field is set to In progress.

4. Select OKOK.

5. In the L ifecycle state: InProgressLifecycle state: InProgress  dialog box, select OKOK.

In this section, you will continue to work on the work order that you worked on in the previous section.

1. On the Action Pane, on the Work orderWork order  tab, in the ProjectProject group, select JournalsJournals .

The Work order journalsWork order journals  page appears. Here, you can register the time that you spent on the work
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order.

2. On the HoursHours  FastTab, select Add lineAdd line.

3. On the new, line, set the HoursHours  field to 4.

4. On the Action Pane, select Post journalsPost journals .

5. Close the Work order journalsWork order journals  page to return to the work order.

6. On the Action Pane, on the InvoicingInvoicing tab, select New invoice proposalNew invoice proposal .

7. In the Create invoice proposalCreate invoice proposal  dialog box, in the Project transactionsProject transactions  section, select the SelectSelect

check box for every line that you want to invoice.

8. Select OKOK to close the dialog box and view the new invoice proposal.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Set a default location for new maintenance assets that are created
from fixed assets (optional)

Work with integrated maintenance assets and fixed assets

Associate an existing maintenance asset with a fixed assetAssociate an existing maintenance asset with a fixed asset

View the fixed asset that is associated with a selected maintenance assetView the fixed asset that is associated with a selected maintenance asset

View the maintenance asset that is associated with a selected fixed assetView the maintenance asset that is associated with a selected fixed asset

By integrating the Asset managementAsset management and Fixed assetsFixed assets  modules, you can link fixed assets with maintenance

assets. Fixed assets users can then create a maintenance asset from a new or existing fixed asset, and Asset

management users can associate a maintenance asset with an existing fixed asset. This feature also makes it

easy for Fixed assets users to view the costs that were posted from work orders for related maintenance assets.

In this topic, maintenance assets refer to assets from the Asset managementAsset management  module, and fixed assets refer to assets

from the Fixed assetsFixed assets  module.

This optional configuration lets you set a default functional location for new maintenance assets that are created

from fixed assets. You typically complete this configuration this just one time, if you complete it at all.

To complete the configuration, follow these steps.

1. Go to Asset management > Setup > Asset management parametersAsset management > Setup > Asset management parameters .

2. On the Fixed assetsFixed assets  tab, in the Functional locationFunctional location field, select the default location.

3. On the Action Pane, select SaveSave.

This section provides a collection of procedures that show various ways that you can work with the integrated

Asset management and Fixed assets features.

To associate an existing maintenance asset with a fixed asset, follow these steps.

1. Go to Asset management > Assets > All assetsAsset management > Assets > All assets  (or Active assetsActive assets ).

2. Select an asset.

3. On the Fixed assetFixed asset FastTab, in the Fixed asset numberFixed asset number  field, select an existing fixed asset.

4. On the Action Pane, select SaveSave.

To view the fixed asset that is associated with a selected maintenance asset, follow these steps.

1. Go to Asset management > Assets > All assetsAsset management > Assets > All assets  (or Active assetsActive assets ).

2. Select an asset.

3. On the Fixed assetFixed asset FastTab, in the Fixed asset numberFixed asset number  field, select the link.

The Fixed assetsFixed assets  page for the selected asset is opened. (Typically, this page is found at Fixed assets >Fixed assets >

Fixed assets > Fixed assetsFixed assets > Fixed assets .)

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/integration-to-fixed-assets/fixed-asset-integration.md


  

View maintenance costs that are associated with a fixed assetView maintenance costs that are associated with a fixed asset

Create a new maintenance asset for an existing fixed assetCreate a new maintenance asset for an existing fixed asset

Create a new fixed asset and add a new maintenance asset for itCreate a new fixed asset and add a new maintenance asset for it

Remove the association between two assetsRemove the association between two assets

To view the maintenance asset that is associated with a selected fixed asset, follow these steps.

1. Go to Fixed assets > Fixed assets > Fixed assetsFixed assets > Fixed assets > Fixed assets .

2. Select an asset.

3. On the Action Pane, on the Asset managementAsset management tab, in the ViewView  group, select Maintenance assetMaintenance asset.

The Maintenance assetMaintenance asset page for the asset that is associated with the selected fixed asset is opened.

(Typically, this page is found at Asset management > Assets > All assetsAsset management > Assets > All assets .)

Asset management work orders can be posted for maintenance assets, and each of those work orders typically

has a cost. When a fixed asset is associated with a maintenance asset, you can go directly from the fixed asset to

view the related costs.

To view the maintenance costs that are associated with a fixed asset, follow these steps.

1. Go to Fixed assets > Fixed assets > Fixed assetsFixed assets > Fixed assets > Fixed assets .

2. Select an asset.

3. On the Action Pane, on the Asset managementAsset management tab, in the ViewView  group, select Maintenance costMaintenance cost.

The Maintenance costMaintenance cost page is opened and shows the related costs.

To create a new maintenance asset for an existing fixed asset, follow these steps.

1. Go to Fixed assets > Fixed assets > Fixed assetsFixed assets > Fixed assets > Fixed assets .

2. Select an asset.

3. On the Action Pane, on the Asset managementAsset management tab, in the NewNew  group, select Create maintenance assetCreate maintenance asset.

(If this option is unavailable, a maintenance asset might already be associated with the selected fixed asset.)

4. Finish creating the asset as described in Create an asset.

To create a new fixed asset and add a new maintenance asset for it, follow these steps.

1. Go to Fixed assets > Fixed assets > Fixed assetsFixed assets > Fixed assets > Fixed assets .

2. On the Action Pane, select NewNew .

3. Finish creating the fixed asset as described in Create a fixed asset.

4. On the Action Pane, on the Asset managementAsset management tab, in the NewNew  group, select Create maintenance assetCreate maintenance asset.

5. Finish creating the asset as described in Create an asset.

In some cases, you might have to disassociate a maintenance asset from its fixed asset. For example, if you want

to create a new maintenance asset from a fixed asset, you must first remove any existing association.

To remove an existing association between a maintenance asset and a fixed asset, follow these steps.

1. Go to Asset management > Assets > All assetsAsset management > Assets > All assets  (or Active assetsActive assets ).

2. Find and open the fixed asset.

3. On the Fixed assetFixed asset FastTab, clear the value from the Functional locationFunctional location field.

4. On the Action Pane, select SaveSave.

https://docs.microsoft.com/en-us/dynamics365/finance/fixed-assets/tasks/create-fixed-asset
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This topic explains preventive maintenance in Asset Management. Preventive maintenance is a discipline

involving planned maintenance jobs, for example, regular service, calibration, and inspections. In AssetAsset

ManagementManagement, you can create maintenance plans and set them up on assets and functional locations. You can

also set up maintenance rounds on functional locations. Maintenance plans on assets are active regardless of

where the asset is installed. Maintenance plans and maintenance rounds on functional location are active for the

assets currently installed at the location. Instead of setting up maintenance plans on assets, or setting up

maintenance rounds on functional locations, you can create maintenance rounds that include multiple assets on

which you need to perform related types of maintenance jobs in the same work routine. Maintenance rounds

created from assets - instead of created on functional locations - means that you can select a number of assets

for one maintenance round, which are not installed on the same functional location.

Maintenance plans are used for preventive and reactive maintenance on individual assets. Maintenance rounds

are used for preventive maintenance on a group or a set of assets. Maintenance plans and maintenance rounds

are used for generating work order proposals. The work order proposals are saved as maintenance schedule

lines, which can be bundled and converted into work orders.

The following illustration provides an overview of the work flow from creating maintenance plans and

maintenance rounds to creating work orders for assets, based on those maintenance plans and maintenance

rounds.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/preventive-and-reactive-maintenance/preventive-maintenance-overview.md
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Set up maintenance plans

A maintenance plan defines when a pre-planned preventive maintenance job is to be carried out on an asset.

Maintenance plans can be related to assets, asset types, functional locations, or functional location types, but

first you create the maintenance plans to be used in your company.

A maintenance plan can have multiple maintenance plan lines. Maintenance job type and interval are specified

on the maintenance plan line. There are two types of maintenance plan lines:

Time

Counter

Maintenance plan lines of type "Time" are used for recurring planned maintenance based on a fixed time

interval. Maintenance plan lines of type "Counter" are used for planned maintenance or reactive maintenance

based on asset counter registrations. A maintenance plan may include several maintenance plan lines of both

types.

If no counter values have been registered for a counter type on an asset, the maintenance plan lines are omitted.

First, you create the maintenance plans you require for your preventive maintenance jobs and select the asset

types, assets, functional location types, and functional locations that should be related to each maintenance plan.

Afterwards, if required, you can also add maintenance plans to an asset or a functional location, which is done in

All assetsAll assets  > select asset > Asset maintenance plansAsset maintenance plans  FastTab, or All functional locationsAll functional locations  > select

functional location > Maintenance plansMaintenance plans  FastTab.

If you add a maintenance plan to asset types or functional location types, it means that when you create new

assets or functional locations with those asset types or functional location types, the asset or functional location

will automatically be added to the maintenance plan. The start date of the relation to a maintenance plan will be

the current date, which may need to be adjusted.

This section describes how to set up maintenance plan lines and provides examples of how they can be used.

NOTENOTE

1. Go to Asset management > Setup > Preventive maintenance > Maintenance plansAsset management > Setup > Preventive maintenance > Maintenance plans .

2. Select NewNew  to create a new sequence.

3. Insert an ID in the Maintenance sequenceMaintenance sequence field, and a name in the NameName field.

4. In the Plan datePlan date field, insert the start date from which planning can be done on the maintenance plan.

Note that time-based maintenance plan lines may have other plan dates.

5. Select "Yes" in the ActiveActive toggle button to activate the maintenance plan.

If you deactivate a maintenance plan, no schedule posts will be created in the maintenance schedule when you

run a schedule maintenance plan job.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/preventive-and-reactive-maintenance/maintenance-plans.md
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6. The Tolerance days beforeTolerance days before and Tolerance days afterTolerance days after  fields relate to maintenance plan lines in which

the Suppress overlapping maintenance jobsSuppress overlapping maintenance jobs  check box is selected (refer to step 17). The "Tolerance"

fields are used to extend the interval in days in which, if several maintenance plans overlap, the most

comprehensive / largest job is created as a maintenance schedule line during maintenance plan

scheduling, while more frequent, overlapping jobs are omitted during maintenance plan scheduling.

Insert number of days in the Tolerance days beforeTolerance days before field, for example "2".

7. If you have inserted a value in Tolerance days beforeTolerance days before, also insert number of days in the ToleranceTolerance

days afterdays after  field, for example "2".

The example described in this and the previous step means that if several maintenance plan lines overlap, and

Suppress overlapping maintenance jobsSuppress overlapping maintenance jobs is selected for one or more lines, the period of omitting

maintenance schedule lines is extended to a total of five days (the expected start date on the maintenance

schedule line and two days before and two days after that date).

8. The fields in the DetailsDetails  group on the DetailsDetails  FastTab show number of maintenance plan lines set up on

the maintenance plan, and number of assets and functional locations related to the maintenance plan.

9. On the L inesLines  FastTab, select Add time lineAdd time line or Add asset counter lineAdd asset counter line to create a new maintenance

plan line.

10. Insert a description for the line in the Work order descr iptionWork order descr iption field. The description is transferred to

related work orders.

11. In the Maintenance job typeMaintenance job type field, select the job type to which the maintenance plan line is related.

12. In the Maintenance job type var iantMaintenance job type var iant and TradeTrade fields, select the variant and trade related to the

maintenance job type.

13. In the Finish within daysFinish within days  and Finish within hoursFinish within hours  fields, you can insert expected end date in days or

hours. The expected end date is inserted relative to the expected start date, which is calculated when

maintenance schedule lines are created. For example, you can insert "7" in the Finish within daysFinish within days  field

to indicate that the related job should be completed within a week from the expected start date.

14. In the Inter val typeInter val type field, select the type of interval to be used on the maintenance plan line, for

example, "Repeated..." or "Once...". Refer to the Interval types overview table below for a description of the

relation between interval types and line types.

15. The PeriodPeriod field only relates to time-based line types. Select the period type related to the period

frequency.

16. In the Period frequencyPeriod frequency  field, insert the number of times the line should be used for planning

preventive maintenance jobs. Example: If you have created a line of type "Counter", and your counter is

production quantity, and you insert the number "20000" in this field, new maintenance sequence lines

are created during preventive maintenance scheduling every time you are expected to produce 20,000

more items.

17. The Suppress overlapping maintenance jobsSuppress overlapping maintenance jobs  check box relates to time-based as well as counter-

based line types. Select the check box to delete maintenance schedule entries that are created on the

same date. This is relevant if, for example, you have created a 1-month inspection line, a 6-month

inspection line, and a 1-year inspection line. For the 1-year inspection you only want that inspection to be

done, not the other two inspections, which would also fit in the time frame. In order to set up this

example correctly, you set up the 1-year inspection line as the first line, the 6-month line as the second

line, and the 1-month line as the third line, and you select the Suppress overlapping maintenanceSuppress overlapping maintenance
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jobsjobs  check box for the 1-month and 6-month lines. That way you ensure that when you reach the 1-year

mark, the inspections for one month and six months are omitted, and a maintenance schedule line is only

created for the 1-year inspection line.

The example described in this step shows that the most comprehensive job, which contains the largest number of

tasks, and which is not done so often, should always be inserted as the first line. The more frequent jobs are then

inserted as separate lines in the order of frequency, placing the most frequent job at the bottom of the list.

18. The CounterCounter  field only relates to counter-based line types. Select the counter type to be used on the line.

If a counter type is not active on a related asset, the maintenance plan line is omitted.

19. The Asset counter time fence in daysAsset counter time fence in days  field only relates to counter-based line types. Insert a number

that defines how many days back counter registrations are checked when maintenance plan scheduling is

done. This means how far back are data (existing counter registrations) used as basis for calculating the

trend that determines how many maintenance schedule lines are created.

Example: If counter registrations are expected to be made once a month, you may insert the number

'365' in this field because maintenance plan scheduling will always be based on the last 12 months

and therefore create maintenance schedule lines based on the trend of the past year. On the other

hand, if you insert the number '10' in this field, you expect counter registrations to be made more

often, for example, on a daily basis. This means that when you schedule maintenance plan, counter

registrations for the last 10 days are used as the basis for the scheduling of maintenance schedule

lines.

20. The Plan datePlan date field only relates to time-based line types. If the maintenance plan line has another

planning date than the entire maintenance plan, select a date in the Plan datePlan date field on the line.

21. In the Ser vice levelSer vice level  field, you can select a work order service level as a further delimitation on the

maintenance plan line - to be used as a service level on work orders.

22. Select the Auto createAuto create check box if you want a work order to be automatically created according to the

selected maintenance plan line when scheduling maintenance plans.

23. If you have selected the Auto createAuto create check box, you can select a work order type for the auto-created

work order in the Work order typeWork order type field. If you have selected the Auto createAuto create check box, and you do

not select a work order type in this field, the work order type selected in Asset management > SetupAsset management > Setup

> Asset management parameters > Work orders> Asset management parameters > Work orders  link > Preventive work order typePreventive work order type field is

used.

24. Use the Season fromSeason from and Season toSeason to fields to create a repeated time-based maintenance plan line

within a 12-month period. Example: Equipment used for maintaining green areas requires service each

spring within a predefined period. Insert the start date of the period to be repeated in the Season fromSeason from

field.

25. Insert the end date of the period to be repeated in the Season toSeason to field.

26. In the Resulting periodResulting period field, the current period to be repeated is shown. When the current period has

passed, and you start a new year, the period shown in this field will be updated to reflect the next period

in the repeat sequence.

27. On the AssetsAssets  FastTab, select the assets that should be related to the maintenance plan.

28. On the Asset typesAsset types  FastTab, select the asset types that should be related to the maintenance plan.
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Interval types overview
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Inter val type: Repeated from planInter val type: Repeated from plan
datedate The count starts from the plan
date used. When you schedule
maintenance plans, maintenance
schedule lines are created when the
interval is reached.

The Plan datePlan date on the maintenance
plan line is used. If no plan date is
selected on the line, the Plan datePlan date for
the maintenance plan is used. Example:
If the number "3" is inserted in the
Period frequencyPeriod frequency  field, and "Year" is
selected in the PeriodPeriod field, a new
maintenance schedule line will be
created once every 3 years.

The Plan datePlan date for the maintenance
plan is used. If the counter has been
replaced, the latest replacement date is
used as the plan date.

Inter val type: Repeated fromInter val type: Repeated from
star t datestar t date The count starts from the
start date on the asset relation. The
date is selected in the All assetAll asset  details
view > Asset maintenance plansAsset maintenance plans
FastTab > Star t dateStar t date field, or in the
All functional locationsAll functional locations details view
> Maintenance plansMaintenance plans FastTab >
Star t dateStar t date field. When you schedule
maintenance plans, a maintenance
schedule line is created when the
interval is reached.

The start date of the maintenance plan
line on asset or functional location is
used. If that field is blank, the PlanPlan
datedate for the maintenance plan is used.

The start date of the maintenance plan
line on asset or functional location is
used. If that field is blank, the PlanPlan
datedate for the maintenance plan is used.

Inter val type: Repeated from lastInter val type: Repeated from last
work orderwork order  The count starts from the
actual end date and time of the latest
work order that was completed on the
asset with that specific maintenance
job type / maintenance job type
variant / trade combination. That date
and time is shown in the Actual endActual end
field in the All work orderAll work order  details
view.

The actual end date and time of the
work order completed on the asset
with that specific maintenance job type
/ maintenance job type variant / trade
combination. If no completed work
order is found, one of the dates used
in the "Repeated from start date"
interval type described above is used
instead.

The actual end date and time of the
work order completed on the asset
and the maintenance job type /
maintenance job type variant / trade
combination. is used. If the end date
and time was left blank on the work
order, one of the dates used in the
"Repeated from start date" interval
type described above is used instead.

29. On the Functional locationsFunctional locations  FastTab, select the functional locations that should be related to the

maintenance plan. If required, you can make the setup more specific by selecting a related asset type,

manufacturer, and model.

30. On the Functional location typesFunctional location types  FastTab, select the functional location types that should be related to

the maintenance plan.

When work orders are manually created on assets that are covered by a vendor warranty, a dialog box is shown to make

the user aware of the warranty. The creation of the work order can then be canceled. The check for a warranty relation is

omitted for work orders that are automatically created.

   



Inter val type: Once from planInter val type: Once from plan
datedate See description for the "Repeated
from plan date" interval type above.
Only difference is that this interval
type is to be used only once.

See description for "Repeated from
plan date" interval type above. This
interval is typically used for a one-time
maintenance or service job.

See description for "Repeated from
plan date" interval type above. This
interval is typically used for a one-time
maintenance or service job. Note 1:Note 1:
This interval type is only relevant if the
counter is replaced every time you
carry out a maintenance or service job.
If, for some reason, a counter has been
replaced before the end of the planned
interval, a new time is calculated for
the job from the time of the counter
replacement. Note 2:Note 2:  If the counter is
replaced when completing the
maintenance or service job, this
interval type functions as the
"Repeated from plan date" interval
type above.

Inter val type: Once from star tInter val type: Once from star t
datedate See description for the "Repeated
from start date" interval type above.
Only difference is that this interval
type is to be used only once.

See description for "Repeated from
start date" interval type above. This
interval is typically used for a one-time
maintenance or service job.

See description for "Repeated from
start date" interval type above. This
interval is typically used for a one-time
maintenance or service job. Note 1Note 1
above also applies to this interval type.
Note 3:Note 3:  If the counter is replaced
when completing the maintenance or
service job, this interval type functions
as the "Repeated from start date"
interval type above.

Inter val type: Once reachedInter val type: Once reached
aboveabove This interval type only relates
to counters and is used for indicating
an upper limit set up on the
maintenance plan line. Maintenance
schedule entries will have the expected
start date and time of the counter
registration, meaning these entries will
be created with an expected start date
equal to or earlier than the system
date.

Not applicable The counter interval indicates an upper
limit. If that limit is exceeded when you
create a counter registration, a
maintenance schedule line is created
when you schedule preventive
maintenance.

Inter val type: Once reachedInter val type: Once reached
belowbelow This interval type only relates
to counters and is used for indicating a
lower limit set up on the maintenance
plan line. Maintenance schedule
entries will have the expected start
date and time of the counter
registration, meaning these entries will
be created with an expected start date
equal to or earlier than the system
date.

Not applicable The counter interval indicates a lower
limit. If that limit is passed when you
create a counter registration, a
maintenance schedule line is created
when you schedule preventive
maintenance.
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Inter val type: Linked from star tInter val type: Linked from star t
datedate This interval type only creates a
maintenance schedule line once. A
maintenance plan can contain more
maintenance plan lines using this
interval type, and those lines are
linked. Typically, you will create a
maintenance plan that contains lines
of only this interval type. Maintenance
schedule lines are created by
identifying the maintenance plan line
that has the first expected start date
and time.

See description for "Once from start
date" above. Example: You create two
lines in a maintenance plan for a
service job on a car: one time-based
line with a 1-year period, and one
counter-based line with a 25,000 km
limit. A maintenance schedule line is
created for the limit that is reached
first. For this line type you create the
line with the 1-year period.

See description for "Once from start
date" above. Example: You create two
lines in a maintenance plan for a
service job on a car: one time-based
line with a 1-year period, and one
counter-based line with a 25,000 km
limit. A maintenance schedule line is
created for the limit that is reached
first. For this line type you create the
line with the 25,000 km limit. Example
creating two counter lines: You can
also set up a maintenance plan with
two linked, counter-based lines in
which the first line has a limit of
10,000 items quantity produced, and
the second line relates to the machine
or work center requiring service after
running 3,000 hours.

Inter val type: Linked from lastInter val type: Linked from last
work orderwork order  This interval type creates
new maintenance schedule lines after
every completed work order. A
maintenance plan can contain more
lines using this interval type, and
those lines are linked. Typically, you will
create a maintenance plan that
contains maintenance plan lines of
only this interval type. Maintenance
schedule lines are created by
identifying the maintenance plan line
that has the first expected start date
and time.

This interval type basically works as
"Linked from start date" described
above. Only difference is the date on
which the interval type is based. The
date used is the actual date and time
on the latest work order completed on
the asset and the maintenance job
type / maintenance job type variant /
trade combination.

This interval type basically works as
"Linked from start date" described
above. Only difference is the date on
which the interval type is based. The
date used is the actual date and time
on the latest work order completed on
the asset and the maintenance job
type / maintenance job type variant /
trade combination.

Inter val type: Repeated onInter val type: Repeated on
aggregated value (Counter only)aggregated value (Counter only)
When the maintenance plan is run, a
scheduled maintenance line will be
created each time that the
accumulated value for an asset
counter reaches the period frequency
or an even multiple of the period
frequency. (The period frequency is
defined on the maintenance plan line.)

Not applicable Example:Example:  An hour counter is set up
for asset AK-101. An asset plan line is
also set up for the asset. The interval
type of this line is Repeated on
aggregated value (Counter only), and
the period frequency is 1000. When
the maintenance plan is run, a
scheduled maintenance line will be
generated when the aggregated value
for the counter exceeds 1,000 hours.
Then, when the aggregated value for
the counter exceeds 2,000 hours,
another scheduled maintenance line
will be generated, and so on for every
additional 1,000 hours.
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For more information about how
to enable and use this
functionality, see the Counter-
based maintenance enhancements
section later in this topic.



Inter val type: Once onInter val type: Once on
aggregated value (Counter only)aggregated value (Counter only)
When the maintenance plan is run, a
scheduled maintenance line will be
created when the accumulated value
for an asset counter reaches the
period frequency that is defined on the
maintenance plan line.

Not applicable Example:Example:  An hour counter is set up
for asset AK-101. An asset plan line is
also set up for the asset. The interval
type of this line is Once on aggregated
value (Counter only), and the period
frequency is 1000. When the
maintenance plan is run, a scheduled
maintenance line will be generated
when the aggregated value for the
counter exceeds 1,000 hours.
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For more information about how
to enable and use this
functionality, see the Counter-
based maintenance enhancements
section.

When maintenance schedule lines are created for time-based maintenance plan lines, expected time is always at the start

of the day. For counter-based maintenance plan lines, expected time can be anytime during the day.

Below you will find examples of the setup of time-based and counter-based maintenance plan lines:

Example 1 - Time-based maintenance plan line:Example 1 - Time-based maintenance plan line: A lubrication job may be set up in a fixed interval,

occurring once a week. For that purpose, select "Repeated from plan date" in the Inter val typeInter val type field. See an

example in the following illustration.

Example 2 - Time-based maintenance plan line:Example 2 - Time-based maintenance plan line: An inspection job may be set up to be carried out

approximately once a week. For that purpose, select "Repeated from last work order" in the Inter val typeInter val type field.

See an example in the following illustration.

Example 3 - Counter-based maintenance plan line:Example 3 - Counter-based maintenance plan line: The following graphic illustration shows an hour

counter for which a new maintenance schedule line is created each time 250 hours have passed. The interval

type for this counter-based line is "Repeated from start date". The start date is the start date of the related assets

in the All assetsAll assets  details view > Asset maintenance plansAsset maintenance plans  FastTab > Star t dateStar t date field, or in the FunctionalFunctional

locationlocation details view > Maintenance plansMaintenance plans  FastTab > Star t dateStar t date field. This is an example of a preventive

maintenance plan because the maintenance schedule line is automatically created each time the threshold (+

250) is reached.



Example 4 - Counter-based maintenance plan line:Example 4 - Counter-based maintenance plan line: The following graphic illustration shows a decrease in

counter value, measuring brake pad wear. A maintenance schedule line is created when a counter registration

below 20 mm is created on the brake pad. The interval type for this counter-based line is "Once reached below"

or "Once from last start date". This is an example of a reactive maintenance plan because the maintenance

schedule line is not created until a measurement below 20 mm is registered.

Example 5 - Counter-based maintenance plan line:Example 5 - Counter-based maintenance plan line: The following graphic illustration shows a counter

with a threshold of -18° Celsius. A maintenance schedule line is created when a counter registration above -18°

Celsius is made. The interval type for this counter-based line is "Once reached above". This is an example of a

reactive maintenance plan because the maintenance schedule line is not created until a measurement higher

than -18° Celsius is registered.



Add a maintenance plan to an asset

When you create a new asset, and that asset uses an asset type related to a maintenance plan, the

maintenance plan is automatically inserted in All objects > Asset maintenance plansAll objects > Asset maintenance plans  FastTab. Also, in the

Asset type defaultsAsset type defaults , on the Maintenance plansMaintenance plans  FastTab, the related maintenance plans will automatically

be inserted.

If you add or remove asset types or functional location types in Maintenance plansMaintenance plans , that change will only

reflect on new assets created after you made the change.

If you add or remove assets or functional locations in Maintenance plansMaintenance plans , that change will automatically be

updated in All assets > Asset maintenance plansAll assets > Asset maintenance plans  FastTab, or in All functional locations >All functional locations >

Maintenance plansMaintenance plans  FastTab.

The following illustration shows an example of a "Truck service" maintenance plan on the Maintenance plansMaintenance plans

page.

1. Go to Asset management > Common > Assets > All assetsAsset management > Common > Assets > All assets  or Active assetsActive assets .



Counter-based maintenance enhancements

IMPORTANTIMPORTANT

2. Select the asset on which you want to set up a maintenance plan and select EditEdit.

3. On the Asset maintenance plansAsset maintenance plans  FastTab, select Add lineAdd line to add a maintenance plan to the asset.

4. In the Maintenance planMaintenance plan field, select the relevant maintenance plan.

5. In the Star t dateStar t date field, select the date from which planning of preventive maintenance jobs can be done.

6. Select SaveSave. The ActiveActive field is automatically updated.

The following illustration shows an example of maintenance plans set up on an asset on the All assetsAll assets  page.

  

The functionality that is described in this section is available as part of a preview release. The content and the functionality

are subject to change. For more information about preview releases, see One version service updates FAQ.

The Counter-based maintenance enhancements feature introduces the following functionality:

The option to automatically insert a counter that has a value of 0 (zero) when an asset is created. This option

can be useful when you use predictive maintenance that is based on counters. When the Counter-based

maintenance enhancements feature isn't used, counters that have a value of 0 (zero) must be manually

inserted.

The ability to configure a counter so that it's automatically reset when a work order is completed. This

functionality is useful when you want to schedule maintenance based on the aggregated value since the last

https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version


Turn on the Counter-based maintenance enhancements featureTurn on the Counter-based maintenance enhancements feature

Create and initialize counters when an asset is createdCreate and initialize counters when an asset is created

NOTENOTE

Automatically reset a counter valueAutomatically reset a counter value

work order was completed.

A new type of maintenance plan interval that is named Repeated on aggregated value (Counter only). This

type triggers maintenance each time that an aggregated counter reaches a multiple of a specific value. For

example, maintenance can be triggered every 10,000 hours. For more information, see the Interval types

overview section earlier in this topic.

Another new type of maintenance plan interval that is named Once on aggregated value (Counter only). This

type triggers maintenance when an aggregated counter reaches a specific value, such as 8,000 hours. For

more information, see the Interval types overview section.

Before you can use this feature, it must be turned on in your system. Admins can use the feature management

settings to check the status of the feature and turn it on. In the Feature managementFeature management workspace, the feature is

listed in the following way:

Module:Module: Asset Management

Feature name:Feature name: (Preview) Counter-based maintenance enhancements

Each time that you create an asset, related asset counters that are initialized to a value of 0 (zero) can

automatically be created, provided that you set up your system and create the asset correctly.

1. Go to Asset management > Setup > Asset typesAsset management > Setup > Asset types .

2. Make sure that you have an asset type that is applicable to your planned new asset. Create an asset type as

required. Make sure that all the relevant counters are selected on the CountersCounters  FastTab.

3. Go to Asset management > Setup > Asset types > CountersAsset management > Setup > Asset types > Counters .

4. For each relevant counter, make sure that the Total aggregateTotal aggregate field is set to Sum.

5. On the All assetsAll assets  page, create the asset.

6. Set the Asset typeAsset type field to the asset type that you identified or created in step 2.

7. Finish setting up the new asset as required.

8. Go to Asset management > Inquir ies > Assets > CountersAsset management > Inquir ies > Assets > Counters . You should be able to find the initialized

counters that are set up for your new asset.

When initialized asset counters are created, the assumption is that the asset had never been used before it was added to

the system. When the maintenance schedule is run for the first time, the calculation uses the date and the 0 (zero)

counter value as a baseline for calculating future maintenance. If the asset wasn't new when it was added to the system,

you can manually adjust the counter value so that it matches the actual counter value. To adjust a counter value, open the

relevant asset on the All assetsAll assets  page, and then, on the Action Pane, on the AssetAsset  tab, in the PreventativePreventative group,

select CountersCounters . On the Asset countersAsset counters  page for the selected asset, adjust the value in the ValueValue column for the initial

counter record as required.

You can configure the system to automatically reset a counter each time that a relevant work order reaches a

selected status value.

1. Go to Asset management > Setup > Preventive maintenance > Maintenance plansAsset management > Setup > Preventive maintenance > Maintenance plans .

2. In the list pane, select a maintenance plan. The counter reset will apply to all assets that use this plan.

3. In the L inesLines  section, find an asset counter line that you want to reset a counter for, and select the ResetReset

countercounter  check box for that line. (Asset counter lines have a value in the CounterCounter  column. The counter that is

specified in that column is the counter that will be reset for the relevant asset.)

4. Go to Asset management > Setup > Work orders > L ifecycle statesAsset management > Setup > Work orders > L ifecycle states .



NOTENOTE

5. In the list pane, select the work order lifecycle state that the relevant counter should be reset at.

6. On the GeneralGeneral  FastTab, set the Reset counterReset counter  option to Yes.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Preventive maintenance scheduling generates calendar entries on assets, based on the maintenance plans set up

on the assets. You can schedule calendar entries based on selected maintenance plans, asset types, and assets.

1. Click Asset managementAsset management > PeriodicPeriodic > Preventive maintenancePreventive maintenance > Schedule maintenance plansSchedule maintenance plans .

2. You can select a time interval in the PeriodPeriod and Period frequencyPeriod frequency  fields.

The PeriodPeriod and Period frequenceyPeriod frequencey fields indicate how far ahead in time you want maintenance schedule lines to be

created, based on the maintenance plans you have created (time-based or counter-based). In the figure below,

maintenance schedule lines (= work order proposals) are created from the current date and three months onwards.

3. Select "Yes" on the Auto create if specified in the lineAuto create if specified in the line toggle button if work orders should automatically

be created according to the maintenance plan line.

If this toggle button is set to "Yes", and the Auto createAuto create check box is also selected on maintenance plan lines in

Maintenance plansMaintenance plans , work orders are created based on the maintenance plan lines, and maintenance schedule lines with

status "Work order created" are also created. If only one option is selected (Auto create if specified in the lineAuto create if specified in the line toggle

button in this dialog or Auto createAuto create check box in Maintenance plansMaintenance plans form), only maintenance schedule lines are

created with status "Created". In that case, no work orders are created.

4. It is possible to generate calendar entries based on maintenance plans (time or counter), assets, asset types,

functional locations, and functional location types. Click the FilterFilter  button and make your selections, if

required.

Regarding scheduling of maintenance plans on functional locations: If you update the setup of asset types,

manufacturers, and models on maintenance plans in All functional locationsAll functional locations  > Maintenance plansMaintenance plans

FastTab after you have scheduled maintenance plans, existing maintenance schedule entries related to that

functional location are automatically deleted. In order to create new calendar entries, which correspond with

the updated maintenance plan setup on the functional location, you must run a new maintenance plan

schedule for that functional location. Read more about the setup of asset types, manufacturers, and models

on functional locations in Create functional locations.

Example: You want to create a maintenance plan for a specific functional location, meaning all assets set up

on that functional location at any given time will be included when you schedule the maintenance plan. In

that case, you create a maintenance plan and select the specific functional location, but you do NOT add any

assets in the maintenance plan. The result is that when you schedule that maintenance plan, maintenance

schedule lines will be created for all the assets related to the functional location at that time.

If you make changes to asset types, manufacturers and models in Asset typesAsset types , those changes only affect

new assets that use the updated asset type. Read more about asset type setup in Asset types.

5. Click OKOK to start the generation of maintenance schedule entries on assets. The generated entries will be

shown in the All maintenance scheduleAll maintenance schedule list page. The following illustration shows an example of the

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/preventive-and-reactive-maintenance/schedule-maintenance-plans.md


Schedule maintenance plansSchedule maintenance plans  dialog.

In the Schedule maintenance plansSchedule maintenance plans  dialog, you can set up batch jobs on the Run in the backgroundRun in the background

FastTab to automatically generate calendar entries at regular intervals.

When you schedule preventive maintenance, maintenance schedule lines with expected start date and time

earlier than the system date and time will not be created.

The figure below provides a graphic illustration of a time-based maintenance plan calculation.



NOTENOTE

Regarding counter-based maintenance plans: In the figures below, two different counter registration cycles are

shown. They are based on a maintenance plan set up for asset "V0001", expecting the asset (a car) to run approx.

2,000 km every month.

In the first example, the expected 2,000 km are not reached every month. According to the counter-based

maintenance plan, the threshold is 2,000 km, meaning when you run a maintenance plan scheduling, a

maintenance schedule line should be created each time the 2,000-kilometer threshold is reached. In example 1,

there are 4 registration lines, but the 2,000-kilometer threshold is only reached once. This means that when you

run schedule maintenance plans this asset, for example for a 3-month period, only one maintenance schedule

line will be created.

In the next figure, 2,000 km or more are registered every month. Therefore, three maintenance lines would be

created if you schedule maintenance plans for this asset for a 3-month period.

The examples described here show that all counter registrations made on an asset show a trend describing wear

and tear on the asset. That trend is used as calculation basis at the time of maintenance plan scheduling.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Set up a maintenance round

In Asset ManagementAsset Management, you can create maintenance rounds for various assets, on which you need to carry out

a similar task at regular intervals. For example, lubrication jobs or safety inspection jobs that need to be carried

out on a number of machines within the same intervals. First step is to create a maintenance round, including

assets that require the same form of maintenance job. Next, you schedule the maintenance rounds. When you

have completed the maintenance rounds schedule, you can see all the job records relating to the round in the

All maintenance scheduleAll maintenance schedule and Open maintenance schedule linesOpen maintenance schedule lines .

Maintenance rounds can also be set up on functional locations to be completed on the assets installed on the functional

location at the time of creation of the round-based work order. Refer to Create functional locations for more information

on the setup of maintenance rounds on functional locations.

1. Click Asset managementAsset management > SetupSetup > Preventive maintenancePreventive maintenance > Maintenance roundsMaintenance rounds .

2. Click NewNew  to create a new maintenance round.

3. Insert and ID in the Maintenance roundMaintenance round field, and a name for the maintenance round in the NameName

field.

4. Select a start date for the round in the Star t dateStar t date field.

5. In the Finish within daysFinish within days  and Finish within hoursFinish within hours  fields, you can insert expected end date in days or

hours. The expected end date is calculated relative to the start date, which is calculated when

maintenance schedule lines are created. For example, you can insert "7" in the Finish within daysFinish within days  field

to indicate that the related job should be completed within a week from the start date.

6. Select "Yes" on the Auto createAuto create toggle button if work orders should automatically be created from

maintenance schedule lines that are created from this maintenance round.

7. In the Work order typeWork order type field, select the work order type to be used on work orders created from this

maintenance round.

8. In the Ser vice levelSer vice level  field, select the work order service level to be used on work orders created from this

maintenance round.

9. On the Asset linesAsset lines  FastTab, click AddAdd to add an asset to the maintenance round.

10. A line number is automatically inserted in the L ine numberLine number  field to indicate the sequence of the assets

in maintenance round.

11. Select the asset in the AssetAsset field.

12. Select the maintenance job type for the asset in the Maintenance job typeMaintenance job type field.

13. If required, select Maintenance job typ var iantMaintenance job typ var iant and TradeTrade related to the maintenance job type.

14. Select the recurrence (day, week, etc.) in the Period typePeriod type field.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/preventive-and-reactive-maintenance/maintenance-rounds.md
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Schedule maintenance rounds

15. In the Period frequencyPeriod frequency  field, insert the number of recurrences for the maintenance round. Example: If

you have selected "Day" in the Period typePeriod type field, and you insert the number "7" in this field, new

maintenance round lines are created during preventive maintenance scheduling once a week.

16. Select a start date for the asset to be included in the maintenance round in the Star t dateStar t date field. This date

may differ from the start date set on the maintenance round.

17. Repeat steps 9-16 to add more assets to the maintenance round.

18. On the Functional location linesFunctional location lines  FastTab, click AddAdd to add a functional location to the maintenance

round. Refer to the description of the related fields above. The same fields are available as for creating an

asset line, but you can also select ManufacturerManufacturer  and ModelModel  for a functional location, if required. If you

only select a functional location on a line, but make no selections in Asset typeAsset type, ManufacturerManufacturer , ModelModel ,

Maintenance job typeMaintenance job type, Maintenance job type var iantMaintenance job type var iant and TradeTrade, all assets related to that functional

location at the time of maintenance scheduling will be included in the maintenance round.

19. On the PoolsPools  FastTab, click AddAdd to select a work order pool to be included in the maintenance round.

Several work order pools can be connected to one maintenance round.

20. Save your setup.

The AssetsAssets  and LinesLines fields located in the DetailsDetails  group on the HeaderHeader  FastTab show the total number of assets and

lines related to the selected maintenance round.

The illustration below shows and example of a maintenance round containing three assets.

When you've set up a maintenance round, you run a schedule job to schedule all the jobs related to the

maintenance round.

1. Click Asset managementAsset management > PeriodicPeriodic > Preventive maintenancePreventive maintenance > Schedule maintenanceSchedule maintenance

roundsrounds , or Asset managementAsset management > CommonCommon > Maintenance scheduleMaintenance schedule > All maintenanceAll maintenance

scheduleschedule or Open maintenance schedule linesOpen maintenance schedule lines  or Open maintenance schedule poolsOpen maintenance schedule pools  > select



NOTENOTE

maintenance schedule line in the list > Maintenance roundsMaintenance rounds  button.

2. In the PeriodPeriod field, select the period type to be used for the scheduling job.

3. In the Period frequencyPeriod frequency  field, insert the number of periods to be included in the scheduling job. The

start of the scheduling is the current date.

4. Select "Yes" on the Auto createAuto create toggle button if a work order should automatically be created on the

basis of a maintenance round.

If this toggle button is set to "Yes", and the Auto createAuto create toggle button is also set to "Yes" on the maintenance round in

Maintenance roundsMaintenance rounds form, work orders are created based on the maintenance round lines, and maintenance schedule

lines with status "Work order created" are also created. If only one of the Auto createAuto create toggle buttons is set to "Yes", in

this drop-down or in Maintenance roundsMaintenance rounds, only maintenance schedule lines are created with status "Created". In that

case, no work orders are created.

5. If required, you can select specific rounds or another start date for the schedule job. Click FilterFilter , and add

the rounds to be included.

6. Click OKOK.

7. You are now able to see the maintenance rounds jobs in Asset managementAsset management > CommonCommon >

Maintenance scheduleMaintenance schedule > All maintenance scheduleAll maintenance schedule or Open maintenance schedule linesOpen maintenance schedule lines . If the

scheduled rounds are connected to a work order pool, you also see maintenance schedule lines in OpenOpen

maintenance schedule poolsmaintenance schedule pools . Maintenance schedule lines created from a round have the reference

type "Maintenance rounds".

The two illustrations below show a schedule job in the Schedule maintenance roundsSchedule maintenance rounds  dialog, and the

maintenance schedule lines created in All maintenance scheduleAll maintenance schedule based on that schedule job.



When work orders are manually created on assets that are covered by a vendor warranty, a dialog box is

shown to make the user aware of the warranty. The creation of the work order can then be canceled. The

check for a warranty relation is omitted for work orders that are automatically created.

You can set up a batch job on the Run in the backgroundRun in the background FastTab to schedule rounds at regular intervals.

If a round is included in several work order pools (refer to Work order pools), one record is shown for each

pool in Open maintenance schedule poolsOpen maintenance schedule pools . This is done to optimize the filtering options for work order
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pools.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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All maintenance schedule All maintenance schedule lines are shown.

My asset schedule All maintenance schedule lines containing assets installed on
functional locations to which you are related as a worker (set
up in Maintenance workers and worker groups) are shown in
this list.

Open maintenance schedule lines Maintenance schedule lines with status "Created" - meaning
they have not yet been converted to a work order or
discarded - are shown in this list.

Open maintenance schedule pools Maintenance schedule lines related to a work order pool are
shown in this list.

NOTENOTE

The maintenance schedule contains a list of all the expected preventive maintenance plans, maintenance

requests, and maintenance rounds to be carried out. Some schedule lines may have been converted to work

orders.

The four maintenance schedule views are slightly different, depending on which maintenance schedule lines you

want to see.

If a maintenance schedule line is included in several work order pools (refer to Work order pools), one record is shown for

each pool in Open maintenance schedule poolsOpen maintenance schedule pools . This is done to optimize filtering options on work order pools.

To open a maintenance schedule:

1. Click Asset managementAsset management > CommonCommon > Maintenance scheduleMaintenance schedule > All maintenance scheduleAll maintenance schedule or

Open maintenance schedule linesOpen maintenance schedule lines  or Open maintenance schedule poolsOpen maintenance schedule pools .

2. To update the maintenance schedule, click Maintenance planMaintenance plan or Maintenance roundsMaintenance rounds .

3. You can edit a maintenance schedule line by selecting it and clicking EditEdit. For example, you can easily

update the service level or the worker responsible for the job. You can only edit maintenance schedule

lines that have not yet been connected to a work order.

4. You can delete a maintenance schedule line by selecting it in the list page and clicking DeleteDelete.

5. You can discard a maintenance schedule line by selecting it in the list page and clicking DiscardDiscard. This

function is useful if, for example, an asset has a 2,000 km maintenance plan and a 10,000 km

maintenance plan. Then, you may want to discard the line created from the 2,000 km maintenance plan

when it coincides with 10,000 km, 20,000 km, 30,000 km, and so on. If you discard a maintenance

schedule line related to a maintenance plan, that line will never again appear when that maintenance plan

is scheduled.

6. You can select a number of maintenance schedule lines in All maintenance scheduleAll maintenance schedule and click WorkWork

order poolorder pool , if you want all selected lines to be included in the same work order pool.
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7. You can select a number of maintenance schedule lines in All maintenance scheduleAll maintenance schedule or OpenOpen

maintenance schedule linesmaintenance schedule lines  or Open maintenance schedule poolsOpen maintenance schedule pools  and click Adjust scheduleAdjust schedule if

you want to make the same adjustments on several lines. You can change expected start and end dates,

service level, and the responsible maintenance worker group or responsible maintenance worker related

to the selected maintenance schedule lines.

When a maintenance schedule line has been related to a work order, the work order ID will be displayed in

the Work orderWork order  field.

In All assetsAll assets  details view > Asset maintenance plansAsset maintenance plans  FastTab, you can select maintenance plans for the

asset. Later, if you delete a maintenance plan line related to an asset in All assetsAll assets , you also automatically

delete all maintenance schedule lines with status "Created" that have been created based on that

maintenance plan. See also Create an asset.

The illustration below shows the All maintenance scheduleAll maintenance schedule list page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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In Asset Management, you can calculate budget costs on maintenance schedule lines. This is useful if you want

to get an overview of expected costs, for example, costs relating to planned preventive maintenance jobs for the

next year. The calculations are based on existing maintenance schedule lines of type "Maintenance plans" and

"Maintenance rounds" and "Maintenance requests".

1. Click Asset managementAsset management > Inquir iesInquir ies  > AssetsAssets  > Maintenance schedule costMaintenance schedule cost.

2. In the Maintenance schedule costMaintenance schedule cost dialog, you can select a Financial dimension setFinancial dimension set if you want to

see costs grouped in financial dimensions.

Financial dimension sets are set up in General ledgerGeneral ledger  > Char t of accountsChar t of accounts > DimensionsDimensions > Financial dimensionFinancial dimension

setssets .

3. You can use the LevelLevel  field to indicate how detailed you want the maintenance schedule lines to be

regarding functional locations. For example, if you insert the number "1" in the field, and you have a

multi-level functional location structure, all maintenance schedule lines for a functional location will be

shown on the top level, and therefore the hours on a line may be added up from functional locations

located at a lower level. If you insert the number "0" in the LevelLevel  field, you will see a detailed result

showing all maintenance schedule lines on all the functional location levels to which they are related.

4. If you want to make a calculation for specific assets, click FilterFilter  on the Records to includeRecords to include FastTab, and

select the relevant assets. If required, you can also specify an Expected star tExpected star t date for the cost calculation

or select a different StatusStatus  for the cost calculation

5. Click OKOK to start the cost calculation.

6. On the Maintenance schedule costMaintenance schedule cost tab > in the Group by...Group by... Action Pane groups, click the relevant

buttons to show the required detail level of the cost calculation. The selected Action Pane group buttons

are highlighted. Click on a button to activate or deactivate it.

7. Click the Calculate costCalculate cost button if you want to make a new cost calculation.

The illustration below shows the results of a maintenance schedule cost calculation.
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Maintenance plans Preventive maintenance jobs that are based on the Time or
Counter maintenance plan type.

Maintenance rounds Preventive maintenance jobs that contain several assets that
require a similar type of maintenance.

Maintenance request A manually created request for maintenance or repair of an
asset. This request can be converted to a work order.

Create work orders based on your maintenance schedule

After you've scheduled preventive maintenance jobs, the next step is to create work orders for them. You can

complete this step by using one of the maintenance schedules. The scheduled jobs in a maintenance schedule

can have different reference types, as described in the following table.

To create work orders that are based on your maintenance schedule, follow these steps.

1. Open one of the following pages, depending on how you want to select schedule items for your work

orders:

All maintenance schedule (Asset management > Management schedule > All maintenanceAsset management > Management schedule > All maintenance

scheduleschedule)

Open maintenance schedule lines (Asset management > Management schedule > OpenAsset management > Management schedule > Open

maintenance schedule linesmaintenance schedule lines )

Open maintenance schedule pools (Asset management > Management schedule > OpenAsset management > Management schedule > Open

maintenance schedule poolsmaintenance schedule pools )

2. In the grid, select the check box for every scheduled maintenance job that you want to create a work

order for. Then, on the Action Pane, select Work orderWork order .

The Create work ordersCreate work orders  dialog box appears. The Maintenance forecast hoursMaintenance forecast hours  field shows the total

number of forecast hours for the selected lines.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/preventive-and-reactive-maintenance/creating-work-orders.md


Group work order lines that are automatically created while a
maintenance plan runs

IMPORTANTIMPORTANT

Enable grouping for automatically generated work ordersEnable grouping for automatically generated work orders

Set up grouping for automatically generated work ordersSet up grouping for automatically generated work orders

3. In the ParametersParameters  section, specify the number of work orders that should be created. Select one of the

following options:

One work order per lineOne work order per line – Create one work order per maintenance schedule line.

One work order perOne work order per  – Create work orders that are grouped according to the settings of the other

options that become available when you select this option.

4. In the Work order typeWork order type field, select the work order type to use for all the work orders that you create.

5. Select OKOK to create the work orders according to your settings.

The functionality that is described in this section is available as part of a preview release. The content and the functionality

are subject to change. For more information about preview releases, see One version service updates FAQ.

This feature lets you define rules for grouping work order lines under a single work order when the system is

set up to generate work orders automatically, based on a maintenance plan. Previously, automatically generated

work orders could contain only one line. However, you can now group work orders by, for example, asset, asset

type, or functional location. (Manually generated work orders could already be grouped in this way, as described

in the previous section of this topic.)

Before you can use this feature, it must be turned on in your system. Admins can use the feature management

settings to check the status of the feature and turn it on. In the Feature managementFeature management workspace, the feature is

listed in the following way:

Module:Module: Asset Management

Feature name:Feature name: (Preview) Apply rules for grouping work orders while running a maintenance plan

https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version
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To set up grouping for automatically generated work orders, follow these steps.

1. Go to Asset management > Setup > Preventative maintenance > Maintenance plansAsset management > Setup > Preventative maintenance > Maintenance plans .

2. For each plan where you want to generate grouped work orders, follow these steps:

a. Select the plan in the list pane.

b. On the L inesLines  FastTab, make sure that the Auto createAuto create check box is selected on every line.

3. Go to Asset management > Periodic > Preventive maintenance > Schedule maintenanceAsset management > Periodic > Preventive maintenance > Schedule maintenance

plansplans .

4. In the Schedule maintenance plansSchedule maintenance plans  dialog box, in the PeriodPeriod section, specify the time horizon for the

plan (how far to look ahead when finding scheduled maintenance jobs to generate work for).

5. Set the Automatically create work order from scheduleAutomatically create work order from schedule option to Yes.

6. In the Work orderWork order  section, select one of the following options:

One work order per lineOne work order per line – Create one work order per maintenance schedule line. (This option

provides the same functionality that is available when the Apply rules for grouping work orders while

running a maintenance plan feature is turned off.)

One work order perOne work order per  – Create work orders that are grouped according to the settings of the other

options that become available when you select this option.

7. If you want the options to apply when you run only some of your maintenance plans, on the Records toRecords to

includeinclude FastTab, add filters as you require, just as you might do for other batch jobs in Microsoft

Dynamics 365 Supply Chain Management.

8. On the Run in the backgroundRun in the background FastTab, set up batch and scheduling options as you require, just as you

might do for other batch jobs in Supply Chain Management.

9. Select OKOK to run and/or schedule the selected maintenance plans.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Maintenance downtime activities

Create a maintenance downtime activity

Maintenance downtime is used to get an overview of the capacity required to carry out maintenance jobs on

specific assets during a specific period. For example, you can create a maintenance downtime registration for

Production line 10 in Production Hall 29-A on production site 02. The maintenance downtime registration has a

start and end time indicating the period in which the assets related to the maintenance stop are not available for

production.

Maintenance downtime activitiesMaintenance downtime activities  is an overview of maintenance schedule lines and work order

maintenance jobs on related assets during a specified period. The lines related to work order maintenance jobs

all have an expected start date within the maintenance stop period. You can extract useful information and make

adjustments to planned maintenance jobs:

Get an overview of required shut-down periods of production equipment (assets).

Get an overview of planned maintenance (hours), grouped by competencies (responsible maintenance

worker groups or maintenance workers), for example capacity load on electricians, smiths, or other

maintenance work groups required to do the planned maintenance jobs.

Make adjustments to maintenance schedule lines or work order maintenance jobs related to the assets, for

example, change expected start and end times on a line, or select other maintenance workers to optimize the

workflow for maintenance workers and maintenance worker groups.

When assets have been selected on a maintenance downtime registration, all open maintenance schedule lines

and work order maintenance jobs relating to active work orders are included in the maintenance downtime

registration.

Click Asset managementAsset management > CommonCommon > Maintenance downtime activitiesMaintenance downtime activities  > All maintenanceAll maintenance

downtime activitiesdowntime activities  to open a list of all maintenance downtime activities and see some of the information

related to the activities. Click on a link in the Maintenance downtime activitiesMaintenance downtime activities  column to open the details

view. The illustration below shows an example of the Maintenance downtime activitiesMaintenance downtime activities  list.

1. Click Asset managementAsset management > CommonCommon > Maintenance downtime activitiesMaintenance downtime activities  > All maintenanceAll maintenance

downtime activitiesdowntime activities  or Active maintenance downtime activitiesActive maintenance downtime activities .

2. Click NewNew .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/preventive-and-reactive-maintenance/maintenance-stop.md
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3. Insert an ID in the Maintenance downtime activitiesMaintenance downtime activities  field and a name in the NameName field.

4. Insert the period for the maintenance stop in the Star t date/timeStar t date/time and End date/timeEnd date/time fields.

5. On the Maintenance downtime activities assetsMaintenance downtime activities assets  FastTab> click Add lineAdd line to add assets, one at a time,

to the maintenance downtime activity.

6. Click SaveSave when all assets have been added. The illustration below shows an example of a maintenance

downtime activity with related assets and maintenance jobs.

7. The work order maintenance jobs and open maintenance schedule lines related to the selected assets are

shown on the Resulting work order maintenance jobsResulting work order maintenance jobs  and Maintenance schedule linesMaintenance schedule lines  FastTabs.

On the GeneralGeneral  FastTab > Work ordersWork orders  group > Maintenance forecast hoursMaintenance forecast hours  field and GeneralGeneral

FastTab > Maintenance scheduleMaintenance schedule group > Maintenance forecast hoursMaintenance forecast hours  field , you see the total

number of hours forecasted for work order maintenance jobs and maintenance schedule lines.

The illustration below shows an example of the Maintenance downtime activitiesMaintenance downtime activities  details view.

The work order maintenance jobs and maintenance schedule lines related to the selected assets are automatically updated

if new work orders or maintenance schedule lines are created after you created the maintenance downtime activity. For

example, if you schedule maintenance plans or maintenance rounds on the related assets two days after the maintenance

downtime activity was created, new maintenance schedule lines are automatically added to the maintenance downtime

activity.

8. In All maintenance downtime activitiesAll maintenance downtime activities  > Maintenance downtime activitiesMaintenance downtime activities  > select a

maintenance downtime activity in the list and click Capacity loadCapacity load to open the Calculate capacity loadCalculate capacity load

dialog. Use this dialog to get an overview of capacity load on, for example, dates, assets, asset types, and

maintenance job types. Note that the dates shown in the dialog are the start and end dates selected in
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Maintenance downtime activitiesMaintenance downtime activities . This calculation includes the assets related to the maintenance

downtime activity.

9. In the Calculate capacity loadCalculate capacity load dialog, edit start and end times if required, and select if you want to

include work orders and maintenance schedules in the calculation. You can use the LevelLevel  field to indicate

how detailed you want the capacity load calculation to be regarding functional locations. For example, if

you insert the number "1" in the field, and you have a multi-level functional location structure, all assets

for a functional location, which are selected on the maintenance downtime activity, will be shown on the

top level, and therefore the hours on a line may be added up from functional locations located at a lower

level. If you insert the number "0" in the LevelLevel  field, you will see a detailed result showing all capacity

load lines on all the functional location levels to which they are related.

10. Click OKOK to start the calculation. The total number of hours is shown in the Capacity loadCapacity load overview. On

the Capacity loadCapacity load tab > the Group by...Group by... Action Pane groups, click the relevant buttons to get a more

detailed overview of the allocation of forecasted hours. The illustration below shows the results of a

Capacity loadCapacity load calculation.

11. After you get an overview of the capacity load, if you want to make adjustments on work order

maintenance jobs or maintenance schedule lines, return to the Maintenance downtime activitiesMaintenance downtime activities

details view and select the lines you want to adjust on the Resulting work order maintenance jobsResulting work order maintenance jobs

and Maintenance schedule linesMaintenance schedule lines  FastTabs.

12. Click the AdjustAdjust button and update expected start/end dates, service level, or responsible maintenance

workers for the selected work order maintenance jobs or maintenance schedule lines.

13. Click OKOK when you have made the required adjustments.

Work order maintenance jobs and maintenance schedule lines that are not included in the maintenance downtime period

after you have made adjustments are automatically removed from Maintenance downtime activitiesMaintenance downtime activities .

14. In All maintenance downtime activitiesAll maintenance downtime activities  > Maintenance downtime activitiesMaintenance downtime activities  > select a

maintenance downtime activity in the list and click Item forecastItem forecast to open the Calculate item forecastCalculate item forecast

dialog. Use this dialog to calculate forecasts for items (spare parts and other required items) and group

them to get an overview, for example, by date, asset, asset type, and maintenance job type. Note that the

dates shown in the dialog are the start and end dates selected in Maintenance downtime activitiesMaintenance downtime activities .

This calculation includes spare parts and items related to the assets that are selected on the maintenance

downtime activity.

15. In the Calculate item forecastCalculate item forecast dialog, edit start and end times if required, and select if you want to

include work orders and maintenance schedules in the calculation. You can use the LevelLevel  field to indicate

how detailed you want the capacity load calculation to be regarding functional locations. For example, if

you insert the number "1" in the field, and you have a multi-level functional location structure, all assets
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for a functional location, which are selected on the maintenance downtime activity, will be shown on the

top level, and therefore the hours on a line may be added up from functional locations located at a lower

level. If you insert the number "0" in the LevelLevel  field, you will see a detailed result showing all capacity

load lines on all the functional location levels to which they are related.

16. Click OKOK to start the calculation. The total number of item forecasts is shown in the Item forecastItem forecast

overview. On the Item forecastItem forecast tab > the Group by...Group by... Action Pane groups, click the relevant buttons to

get a more detailed overview of the allocation of forecasted items.The illustration below shows the

results of an Item forecastItem forecast calculation.

You can copy assets from one maintenance downtime activity to another. In All maintenance downtimeAll maintenance downtime

activitiesactivities , select the Copy maintenance downtime activitiesCopy maintenance downtime activities  button, and make your selections in the

From maintenance downtime activitiesFrom maintenance downtime activities  and To maintenance downtime activitiesTo maintenance downtime activities  fields, and click

OKOK.

In All maintenance downtime activitiesAll maintenance downtime activities , click the Maintenance schedule linesMaintenance schedule lines  button or the ActiveActive

work orderswork orders  button to open the related lists and view the lines related to the selected maintenance

downtime activity.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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In Asset Management, you can calculate capacity load on:

maintenance schedule lines

work orders that have not yet been scheduled

scheduled work orders

This is useful if you want to get an overview of expected capacity load for a specific period. Calculation of

capacity load can be done on all assets or selected assets. You can also make a calculation on maintenance

downtime activities or work order pools.

1. Click Asset managementAsset management > Inquir iesInquir ies  > Capacity loadCapacity load, or Asset managementAsset management > CommonCommon > WorkWork

order poolsorder pools  > All work order poolsAll work order pools  / Active work order poolsActive work order pools  > select work order pool in the list

> Capacity loadCapacity load button, or Asset managementAsset management > CommonCommon > Maintenance downtime activitiesMaintenance downtime activities  >

All maintenance downtime activitiesAll maintenance downtime activities  / Active maintenance downtime activitiesActive maintenance downtime activities  > select

maintenance activity in the list > Capacity loadCapacity load button.

2. In the Calculate capacity loadCalculate capacity load dialog, select a period for the calculation in the Star t date/timeStar t date/time and

End date/timeEnd date/time fields.

3. Select "Yes" on the Include maintenance scheduleInclude maintenance schedule toggle button if you want to include maintenance

schedule lines in the calculation.

4. Select "Yes" on the Include work orderInclude work order  toggle button if you want to include work order jobs in the

calculation.

5. You can use the LevelLevel  field to indicate how detailed you want the capacity load lines to be regarding

functional locations.

For example, if you insert the number "1" in the field, and you have a multi-level functional location

structure, all maintenance schedule lines and work orders for a functional location will be shown on the

top level, and therefore the hours on a line may be added up from functional locations located at a lower

level.

If you insert the number "0" in the LevelLevel  field, you will see a detailed result showing all maintenance

schedule lines and all work orders on all the functional location levels to which they are related.

6. Click OKOK to start the calculation.

7. In the Group by...Group by... groups, click the relevant buttons to show the required detail level of the calculation. In

the screenshot below, the selected Group byGroup by  buttons are highlighted in blue color. Click on a button to

activate or deactivate it.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/capacity-planning/calculate-capacity-load.md
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If you want to focus only on capacity planning regarding scheduled work orders, see Calculate capacity load on scheduled

work orders.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Just as you can make capacity load calculations, which are described in the previous section, you can also make

item forecast calculations on:

maintenance schedule lines

work orders that have not yet been scheduled

scheduled work orders

This is useful if you want to get an overview of expected item consumption (spare parts as well as other items

required for completing work orders) for a specific period. Calculation of item forecast can be done on all assets

or selected assets. You can also make a calculation on a maintenance downtime activity (All maintenanceAll maintenance

downtime activitiesdowntime activities  or Active maintenance downtime activitiesActive maintenance downtime activities ), or on a work order pool (All workAll work

order poolsorder pools  or Active work order poolsActive work order pools ).

1. Click Asset managementAsset management > Inquir iesInquir ies  > Item forecastItem forecast, or Asset managementAsset management > CommonCommon > WorkWork

order poolsorder pools  > All work order poolsAll work order pools  / Active work order poolsActive work order pools  > select work order pool in the list

> Item forecastItem forecast button, or Asset managementAsset management > CommonCommon > Maintenance downtime activitiesMaintenance downtime activities  >

All maintenance downtime activitiesAll maintenance downtime activities  / Active maintenance downtime activitiesActive maintenance downtime activities  > select

maintenance downtime activity in the list > Item forecastItem forecast button.

2. In the Calculate item forecastCalculate item forecast dialog, select a period for the calculation in the Star t date/timeStar t date/time and

End date/timeEnd date/time fields.

3. Select "Yes" on the Include maintenance scheduleInclude maintenance schedule toggle button if you want to include maintenance

schedule lines in the forecast calculation.

4. Select "Yes" on the Include work orderInclude work order  toggle button if you want to include work order jobs in the

forecast calculation.

5. You can use the LevelLevel  field to indicate how detailed you want the item forecast lines to be regarding

functional locations.

For example, if you insert the number "1" in the field, and you have a multi-level functional location

structure, all maintenance schedule lines and work orders for a functional location will be shown on the

top level, and therefore the hours on a line may be added up from functional locations located at a lower

level.

If you insert the number "0" in the LevelLevel  field, you will see a detailed result showing all maintenance

schedule lines and all work orders on all the functional location level to which they are related.

6. Click OKOK to start the calculation.

7. In the Group by...Group by... groups, click the relevant buttons to show the required detail level of the calculation. In

the screenshot below, the selected Group byGroup by  buttons are highlighted in blue color. Click on a button to

activate or deactivate it.

8. Click the Display dimensionsDisplay dimensions  button if you want to see the product, storage, or tracking dimensions

related to the items. Select the relevant check boxes, and click OKOK.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/capacity-planning/calculate-item-forecast.md
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The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

When you schedule work orders, you create a schedule for maintenance workers, tools, and assets. In order to

schedule maintenance workers, a calendar must be set up for each maintenance worker. Maintenance workers

are related to a resource, and working time calendars are set up for resources. You set up the resource and

calendar in Asset managementAsset management > SetupSetup > WorkersWorkers  > WorkersWorkers , which is described in Maintenance workers

and worker groups.

The screenshot below shows an example of a maintenance worker who is related to a resource that uses the

working time calendar "Production".

Calendar setup for tools and assets is not needed in relation to work order scheduling. The assumption is that

tools and assets are available 24 hours a day for maintenance.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/work-order-scheduling/maintenance-worker-calendar-and-scheduling.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Set up preferred workers

During work order scheduling, you can make a preference regarding which maintenance worker or worker

group is allocated to complete the work order. The use of this functionality is optional, but it can help you make

a choice for the most qualified maintenance worker to complete a job, based on worker skills and competencies.

Only maintenance workers that are available at scheduling time will be scheduled. If a preferred maintenance

worker setup matches a work order during scheduling, but the maintenance worker is allocated to other jobs,

the work order will be scheduled to another available maintenance worker.

Before you can set up preferred maintenance workers, you must first set up the maintenance workers and

worker groups. For a description about how to set up maintenance workers and worker groups, see to

Maintenance workers and worker groups.

A preferred maintenance worker or worker group can be related to one or more of the following:

trade

maintenance job type variant

maintenance job type

maintenance job type category

asset

asset type

The more selections you make for the same record, the more specific your setup will be.

1. Click Asset managementAsset management > SetupSetup > WorkersWorkers  > Preferred maintenance workersPreferred maintenance workers .

2. Click NewNew  to create a new record.

3. Start by creating a "default" maintenance worker or worker group. This means that you only make a

selection in the Preferred maintenance worker groupPreferred maintenance worker group field or the Preferred maintenance workerPreferred maintenance worker

field. In the screenshot below, you see an example in the first record in which "Requests" is selected as

Preferred maintenance worker groupPreferred maintenance worker group.

[!NOTE] The default setup will be used during work order scheduling if no other, more specific,

combination matches the contents of the work order.

4. Repeat step 2 to create a new record. Make the required selections, depending on the detail level for the

preferred worker or worker group.

Example: In the screenshot below, in the sixth record, the maintenance worker Shawn Richardson is

selected as preferred worker. He will automatically be selected during scheduling of a work order that

includes the asset "CH-BP1-03-02 and the maintenance job type "Facility assessment", if he is available at

the scheduled time.

[!NOTE] Generally, when a preferred maintenance worker is selected during work order scheduling, Asset

Management goes through all Preferred maintenance workersPreferred maintenance workers  records to check for a possible match,

always checking the most specific combination first. If no match is found, the "default" record with a

selection in either the Preferred maintenance worker groupPreferred maintenance worker group field or the Preferred maintenancePreferred maintenance

workerworker  field is used.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/work-order-scheduling/preferred-maintenance-workers.md
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You can also set up responsible maintenance workers who can be selected when a maintenance request or a

work order is created. You can edit the selection in All work ordersAll work orders  and All maintenance requestsAll maintenance requests , if

required. For more information, see Responsible maintenance workers.

During work order scheduling, different scores are calculated to determine which workers should complete the

jobs related to a work order (those scores are set up in Asset management parametersAsset management parameters  > Work orderWork order

schedulingscheduling link). If two or more preferred maintenance workers or responsible maintenance workers get the

same score during work order scheduling, one worker is randomly selected. Otherwise, it is always the worker

with the highest score who is allocated to complete a work order.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

This topic explains how to schedule work orders in Asset Management.

The required number of hours for a work order is defined by the sum of forecasted hours minus posted hours. If

more time is required, the forecast must be adjusted accordingly. In Asset managementAsset management > CommonCommon > WorkWork

ordersorders  > All work ordersAll work orders  or Active work ordersActive work orders , you can view or edit forecasts on a work order by selecting

the work order and clicking ForecastForecast on the Work orderWork order  tab. When work orders have been created and

estimated, the next step complete the work orders is to allocate the required maintenance workers and tools.

Only work orders with a work order lifecycle state that allows scheduling can be scheduled. Allow scheduling is

set up in Asset managementAsset management > SetupSetup > Work ordersWork orders  > L ifecycle statesLifecycle states  > GeneralGeneral  FastTab > AllowAllow

schedulingscheduling toggle button.

1. Click Asset managementAsset management > CommonCommon > Work ordersWork orders  > All work ordersAll work orders .

2. Select the work orders you want to schedule in the list. For example, you can sort the list by CurrentCurrent

lifecycle statelifecycle state.

3. On the GeneralGeneral  tab, click ScheduleSchedule.

4. In the Schedule work ordersSchedule work orders  dialog, you can add selections regarding expected start date and service

level, if required. If the scheduling process should observe capacity limitations regarding resources

already scheduled for other jobs, make sure that the AssetAsset, ToolTool , and WorkerWorker  toggle buttons are set to

"Yes".

[!NOTE] If you set the AssetAsset, ToolTool , and WorkerWorker  toggle buttons to "No", existing reservations will be

ignored. In the Infolog, a list of overlapping work order schedules will be shown, and you can click on the

messages to open a work order and reschedule, if required.

5. To see detailed information about the scheduling process, select "Yes" on the VerboseVerbose toggle button. This

means that detailed information about the calculated scores on the work orders and maintenance

workers will be shown in the Infolog.

6. Click OKOK to start the scheduling process.

7. When scheduling is completed, an Infolog shows the number of work orders scheduled, and also more

detailed information if the VerboseVerbose toggle button was set to "Yes".

Work orders are scheduled in one cycle per work order, not per work order job. You can also open the Schedule workSchedule work

ordersorders  dialog directly in Asset managementAsset management  > PeriodicPeriodic > Work ordersWork orders  > Schedule work ordersSchedule work orders . Make your

selections and click OKOK to start work order scheduling. It is possible to set up work order scheduling as a batch job in the

Schedule work ordersSchedule work orders  dialog > the Run in the backgroundRun in the background FastTab.

Example: In the figure below, the formula inserted in the Expected star tExpected star t field will generate work order

scheduling for all work orders with expected start date a week from now and later. This formula may be useful

when you run work order scheduling on an ongoing basis, but you want to make sure the work orders

scheduled for the next 5-6 days are not rescheduled.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/work-order-scheduling/schedule-work-orders.md


The work order type related to work orders may set up scheduling for one maintenance worker (AssetAsset

managementmanagement > SetupSetup > Work ordersWork orders  > Work order typesWork order types  > One maintenance workerOne maintenance worker  toggle button

set to "Yes"). This means that if the work order type is used on a work order, the One maintenance workerOne maintenance worker

toggle button is automatically set to "Yes" on the All work ordersAll work orders  details page > HeaderHeader  view > ScheduleSchedule

FastTab. During work order scheduling, all work order jobs created on the work order will subsequently be

scheduled to the same maintenance worker. If required, you can edit the selection on the One maintenanceOne maintenance

workerworker  toggle button in All work ordersAll work orders  to allow scheduling of several workers or one worker on the work

order jobs.

The scheduling process in Asset Management includes several factors in the scheduling calculation:

Calculating scores for both work orders and maintenance workers. Scores for work orders and maintenance

workers are set up in Asset management parametersAsset management parameters .

Checking for matching competencies, meaning skills and certificates, required to perform the job. Skills and

certificates are set up on maintenance workers in the Human resourcesHuman resources  module (Human resourcesHuman resources  >

WorkersWorkers  > WorkersWorkers  > select worker in the list > WorkerWorker  tab > CompetenciesCompetencies  section > SkillsSkills  and

Cer tificatesCer tificates  buttons). Also, skills and certificates can be added to maintenance job types and maintenance

job trades. Read more about competencies and maintenance job types in Maintenance job type categories
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Responsible worker If the maintenance worker is selected as responsible worker
on the work order, the score is added.

and maintenance job types, maintenance job type variants, maintenance job trades, and maintenance

checklists.

Calculating scores for a work order job is based on expected start date and the service level of the work order.

Star t dateStar t date calculation: For every future date calculated from the expected start date, the start date score is

subtracted and multiplied by the score, which is "10" in the examples below.

CriticalityCriticality  calculation: Criticality score multiplied by the criticality on the work order.

Ser vice levelSer vice level  calculation: Service level score divided by the service level on the work order.

In the examples below, the criticality score is "2", and the service level scores are "5" and "100".

Example 1:Example 1:

The work orders will be scheduled in the following order : WO-0001081616 , WO-0001081818 , WO-0001081717 .

Example 2:Example 2:

If the service level score is increased to '100' instead of '5', the scheduling order will be: WO-0001081818 , WO-

0001081616 , WO-0001081717 .

The rating scores relating to calculating which maintenance workers should work on the work orders are all set

up as numbers, which are added to each maintenance worker calculation during work order scheduling. The

maintenance worker with the highest score is selected on the work order. Here is a short description of the

maintenance worker scores:



Responsible maintenance worker group If the maintenance worker is part of the responsible
maintenance worker group on the work order, the score is
added.

Preferred maintenance worker If the worker is selected as preferred maintenance worker on
the asset, the score is added.

Preferred maintenance worker group If the worker is part of the preferred maintenance worker
group on the asset, the score is added.

Location If your company uses functional locations, maintenance
workers get full score if they are located on the functional
location related to the asset. If the functional location of the
asset has a parent location, maintenance workers on that
functional location get 1/2 score. If that location also has a
parent, maintenance workers on that location get 1/3 score.
If that location also has a parent, maintenance workers on
that location get 1/4 score, and so on. If you company uses
asset location, which we do not recommend, location, area,
and zone are used to calculate location scores. Workers get
full score if they are located in the location and area and
zone related to the asset. If worker location only matches
location and area, the rating score for the maintenance
worker is 2/3 of the full score. If maintenance worker
location only matches location, the rating score for the
maintenance worker is 1/3 of the full score.

Worker's start date For every date that the scheduled start date is later than the
expected start date, the score is subtracted.

M A IN T EN A N C E W O RKER SC O REM A IN T EN A N C E W O RKER SC O RE DESC RIP T IO NDESC RIP T IO N

NOTENOTE

Competencies used in work order scheduling

Work with scheduled work orders using a gantt chart

If a score is set to "0", that score is not calculated. This is useful if, for example, you do not want to include a responsible

worker in your scheduling.

Skills and certificate requirements can be set up on maintenance job types (Asset managementAsset management > SetupSetup >

JobsJobs  > Maintenance job typesMaintenance job types ) and maintenance job trades (Asset managementAsset management > SetupSetup > JobsJobs  >

Maintenance job tradeMaintenance job trade).

Maintenance job types and maintenance job trades are selected on work order jobs. If skills or certificates have

been selected on a maintenance job type or maintenance job trade, and that maintenance job type or

maintenance job trade is used on a work order job, only maintenance workers with matching skills and

certificates are scheduled to work on the work order.

 

The Scheduled work orders gantt char tScheduled work orders gantt char t provides a graphical interface where you can view and reschedule

your work orders.

To view and work with the gantt chart:

1. Go to Asset management > Work orders > Scheduled work orders gantt char tAsset management > Work orders > Scheduled work orders gantt char t.



NOTENOTE

2. Use the drop-down lists and fields in the SettingsSettings  section to set up which functional location, time span,

and time scale to show in the gantt chart.

3. Select ApplyApply .

The gantt chart updates to show the scheduled work orders that match your settings. Each work order

is represented by a blue rectangle.

To reschedule a displayed work order, select and then drag it to the appropriate new date and time.

4. If you made any changes, select SaveSave on the Action Pane to save them.
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You can schedule one work order or work order jobs to one worker using the DispatchDispatch functionality.

1. Click Asset managementAsset management > CommonCommon > Work ordersWork orders  > All Work ordersAll Work orders  or Active work ordersActive work orders .

2. Select the work order in the list.

3. On the GeneralGeneral  tab, click DispatchDispatch.

4. In the Schedule work orderSchedule work order  dialog, select the worker in the WorkerWorker  field.

5. In the Schedule hoursSchedule hours  field, you can insert expected work hours in case expected work hours differ

from forecast hours.

6. In the Scheduled star tScheduled star t field, you can edit start date and time, if required.

7. If the scheduling process should observe capacity limitations regarding resources already scheduled on

other jobs, make sure that the AssetAsset, ToolTool , and WorkerWorker  toggle buttons are set to YesYes . If you want to see

detailed information about the scheduling process, select YesYes  on the VerboseVerbose toggle button. This means

detailed information about the calculated scores on the work order is shown in the Infolog.

8. Select YesYes  on the Ignore scheduleIgnore schedule toggle button to ignore closed days in the calendar (applies to asset,

worker, and tools). Select YesYes  on the Ignore scheduled executionIgnore scheduled execution toggle button to ignore limitations

that may have been selected on the work order regarding scheduling.

For information on the setup of scheduled execution, see the Scheduled execution section.

9. Click OKOK. The work order lifecycle state is automatically updated to the ScheduledScheduled lifecycle state

specified Asset managementAsset management > SetupSetup > Work ordersWork orders  > L ifecycle modelsL ifecycle models .

The figure below shows an example of dispatch selections in the Schedule work orderSchedule work order  dialog.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/work-order-scheduling/dispatch-work-order.md
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[!NOTE] If you want to delete the schedule on a work order, select the work order in All work ordersAll work orders , and then

click Delete scheduleDelete schedule on the GeneralGeneral  tab. Remember to manually update the work order lifecycle state if you

delete the schedule.
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If a work order must be scheduled on a specific date and time, you can override the standard scheduling process

in Asset Management and create a specific schedule for a work order.

1. Click Asset managementAsset management > CommonCommon > Work ordersWork orders  > All Work ordersAll Work orders  or Active work ordersActive work orders .

2. In the work order list, click on the Work order ID in the Work orderWork order  column.

3. Click EditEdit.

4. On the Work order headerWork order header  FastTab, insert start and end dates and times in the Expected star tExpected star t and

Expected endExpected end fields.

5. On the GeneralGeneral  tab, click ScheduleSchedule to use the standard scheduling process, or click DispatchDispatch if you

want to assign the work order to a specific worker.

6. In order to override any existing capacity reservations to ensure that the work order is scheduled in the

expected period, make the selections as shown in the figure below in the Schedule work orderSchedule work order  dialog >

Finite capacityFinite capacity  section. This means that the scheduling process will ignore existing capacity reservations

because the work order must start on the expected start time.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/work-order-scheduling/schedule-work-order-on-specific-date-and-time.md
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7. Click OKOK to start scheduling.

8. If the scheduling process results in double bookings, you will see a message on the screen, and you can

adjust the related work orders.

In order to schedule a maintenance worker for the work order, that maintenance worker must be available at the expected

start date and time. Worker availability is set up in the worker calendar.
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View scheduled work order maintenance jobs
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The Scheduled work order maintenance jobsScheduled work order maintenance jobs  page shows an overview of the work orders allocated to a

resource. Work orders using resource types "Human resources", "Tool", and "Machine" are shown. For example,

if a maintenance worker calls in sick, you can use this page to quickly find work orders allocated to the worker,

and then allocate another maintenance worker to the job.

1. Click Asset managementAsset management > CommonCommon > Work ordersWork orders  > Scheduled work order maintenanceScheduled work order maintenance

jobsjobs . You see a list of all work orders set to work order lifecycle state "Scheduled" or "In progress".

2. You can sort the list, for example, by maintenance worker. You can also use the filter to limit the list to

display work orders allocated to a specific resource or maintenance worker.

3. You can see notes on the work order and, if required, add new notes by selecting the work order job, and

then click NotesNotes .

4. If you want to allocate one maintenance worker to a work order, select the work order, and then click

Work orderWork order .

5. The Work orderWork order  page opens. Click DispatchDispatch to schedule the work order to a specific maintenance

worker.

Read more about scheduling several work orders or one work order in Schedule work orders and Dispatch work order.

The following screenshot shows an example of the Scheduled work order maintenance jobsScheduled work order maintenance jobs  page.
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You can calculate capacity load on scheduled work orders to get an overview of the work load on resources for a

specific period. Calculations can be made for the following resources: Maintenance workers, worker groups,

tools, and assets.

1. Click Asset managementAsset management > Inquir iesInquir ies  > ScheduleSchedule > Capacity loadCapacity load.

2. In the Calculate capacity loadCalculate capacity load dialog > ShowShow  field, select which load type you want to calculate:

CapacityCapacity , Reser vedReser ved, or RemainderRemainder .

3. Select YesYes  on the Skip zeroSkip zero toggle button if you do not want to show results containing zero.

4. Select the resource types for which you want to calculate capacity load by selecting YesYes  on the relevant

toggle buttons: WorkerWorker , Maintenance worker groupMaintenance worker group, ToolTool , and AssetAsset.

5. Select the start date for the calculation in the From dateFrom date field.

6. In the Inter val typeInter val type field, select the interval for the calculation: DayDay , WeekWeek, MonthMonth, or Quar terQuar ter .

7. In the Period frequencyPeriod frequency  field, insert the number of intervals you want to calculate. For example, if you

have selected DayDay  as the interval type, and you enter the number "5" in this field, a calculation of five

days from the start date will be made.

8. Click OKOK to start the calculation.

The figure below shows the result of a calculation covering three weeks for the load type Reser vedReser ved.

[!NOTE] If you select the load types CapacityCapacity  or RemainderRemainder  for your calculation, the same result will be

displayed if no reservations have been made for the resources in the selected period.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/work-order-scheduling/calculate-capacity-load-on-scheduled-work-orders.md
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For information about how to calculate capacity load on maintenance schedule lines and not scheduled work

orders, refer to Calculate capacity load.
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NOTENOTE

When a maintenance job has been completed on a work order, the next step is to make consumption

registrations and post the journals. You can make registrations on the following consumption types: Hours,

items, and expenses. The different consumption types are registered and posted on the Work order journalsWork order journals

page. The journal setup in Asset ManagementAsset Management is used for creating and posting separate journals for hours,

items, and expenses in the Project management and accountingProject management and accounting module.

In some cases, you may be able to add or delete forecast lines on a work order. The setup of a work order

lifecycle state, the related project type, and the stage rules related to the project type determine if you are able to

add or edit journal lines. Read more about work order lifecycle states and related project stages in Forecasts,

work orders, and projects.

It is possible to set up automatic posting of journals on a work order lifecycle state. Refer to Work order lifecycle states for

more information.

1. Click Asset managementAsset management > CommonCommon > Work ordersWork orders  > All Work ordersAll Work orders  or Active work ordersActive work orders .

2. Select the work order, and click JournalsJournals .

3. Click Copy from forecastCopy from forecast to transfer any forecast lines that may be connected to the work order. You

can select which consumption types you want to transfer.

4. If necessary, you can add more consumption lines on the relevant FastTab by clicking Add lineAdd line and filling

out data on the line.

5. Click Validate journalsValidate journals  to validate the journal lines before posting.

6. Click Post journalsPost journals  to post the journal lines.

7. After you've posted the consumption journals, you can update the work order lifecycle state. For example,

to indicate that the work order has been completed, you can update the lifecycle state to "Ended".

In the ShowShow  field at the top of the Work order journalsWork order journals  page, select which journal lines you want to

see: AllAll , Not postedNot posted, or PostedPosted. Posted journals have a check mark in the PostedPosted check box.

When item lines are created in the work order journal, product dimensions and tracking dimensions

related to the item are automatically transferred to the journal line.

The screenshot below shows an example of hour and item registrations on a work order in Work orderWork order

journalsjournals .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/consumption/register-consumption.md


Split hours on work orders with several work order jobs
If a work order contains several work order jobs, you can register work hours using the Split hoursSplit hours

functionality, meaning one hour registration line can be distributed evenly on each work order job.

1. Click Asset managementAsset management > CommonCommon > Work ordersWork orders  > All Work ordersAll Work orders  or Active work ordersActive work orders .

2. Select the work order and click JournalsJournals .

3. Select the hour registration line you want to split, and click Split hoursSplit hours .

4. In the Split hours on work order maintenance jobsSplit hours on work order maintenance jobs  dialog, the name of the worker who is logged in

is automatically shown in the WorkerWorker  field. If required, you can select another worker.

5. Select a category for the hour registration in the Categor yCategor y  field.

6. Insert number of work hours to be split in the HoursHours  field.

7. Click OKOK.

Example: In the screenshot below, journal lines for a work order containing three work order jobs are shown.

The first line, containing three work hours, has been split, and one work hour is registered on each work order

job. After the three hour registration lines have been created, you decide what to do with the original hour

registration line (the first line in the example). You can keep it as is or delete it.



Financial dimensions on consumption registrations

NOTENOTE

NOTENOTE

When you make consumption registrations, financial dimensions related to the different registration types are

added to the registrations in a specific sequence.

Hour and Expense registrations: First, financial dimensions from the journal header are added, if any.

Next, financial dimensions from the related work order project are added. Finally, financial dimensions

from the resource (worker) are added.

Item registrations: First, financial dimensions from the journal header are added, if any. Then, financial

dimensions from the related work order project are added. Next, financial dimensions from the site are

added. Finally, financial dimensions from the item are added.

For all three registration types, the financial dimension combination is validated, and invalid combinations are blanked.

This is standard setup with other Finance and Operations apps.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create consumption reports
2/18/2021 • 2 minutes to read • Edit Online

Asset consumption report

Work order consumption report

When you've created and posted consumption registrations on work orders in Asset Management, two reports

are available to display consumption details.

When you have posted consumption on work orders, you can print an asset consumption report. The report

displays hours, hour costs, item costs, and expenses posted on assets.

1. Click Asset managementAsset management > Repor tsRepor ts  > AssetsAssets  > Asset consumptionAsset consumption.

2. In the Asset consumptionAsset consumption dialog, select the parameters and detail level you want to see by selecting

YesYes  on the relevant toggle buttons, and inserting a functional location level in the ShowShow  section.

You can use the LevelsLevels  field to indicate how detailed you want the asset lines to be regarding

functional locations.

For example, if you enter the number "1" in the field, and you have a multi-level functional location

structure, all assets for a functional location will be shown on the top level, and therefore a line

may be added up from functional locations located at a lower level.

If you enter the number "0" in the LevelsLevels  field, you will see a detailed result showing all assets on

all the functional location levels to which they are related.

Select YesYes  on the Sum on all sub assetsSum on all sub assets  toggle button to see sums for each sub asset in the

report.

3. Select a date interval in the DatesDates  section.

4. On the DestinationDestination FastTab, select if you want to display the report on screen, print it, or save it as a file

or email.

5. If required, you can select specific assets to be displayed in the report. On the Records to includeRecords to include

FastTab, click FilterFilter , and add the assets you want to include in the report.

6. Click OKOK to generate the report.

When you have posted consumption on work orders, you can print a work order consumption report. The

report displays hours, hour costs, item costs, and expenses posted on work orders.

1. Click Asset managementAsset management > Repor tsRepor ts  > Work ordersWork orders  > Work order consumptionWork order consumption.

2. In the Work order consumptionWork order consumption dialog, select the parameters you want to include in the report by

selecting YesYes  on the relevant toggle buttons in the ShowShow  section.

3. Select a date interval in the DatesDates  section.

4. On the DestinationDestination FastTab, select if you want to display the report on screen, print it, or save it as a file

or email.

5. If required, you can select specific work orders to be displayed in the report. On the Records to includeRecords to include

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/consumption/create-consumption-reports.md
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FastTab, click FilterFilter , and add the work orders you want to include in the report.

6. Click OKOK to generate the report.

You can also generate a work order report, which contains more work order details.
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Create a warranty agreement

In Asset Management, you can set up warranty terms that can be connected to an asset or an asset type.

Warranty terms are created for a specific period. Warranty can be set up to provide full coverage or partial

coverage, and you can set up terms that are related to hours, expenses, and items.

The first step is to create any vendor warranty agreements that you have for your equipment. You then attach

warranty agreements to assets or asset types. Vendor warranty agreements are used only for informational

purposes. If vendor warranty is set up on an asset, you can see the warranty coverage period on the asset.

A warranty agreement can include several agreement lines to cover the warranty for work hours, expenses, and

items.

1. Select Asset managementAsset management > SetupSetup > AssetsAssets  > WarrantyWarranty .

2. Select NewNew  to create a product.

3. In the WarrantyWarranty  field, enter a warranty ID.

4. In the NameName field, enter a description.

On the DetailsDetails  FastTab, the AssetsAssets  field shows the number of active assets that use the warranty

agreement.

5. On the Warranty linesWarranty lines  FastTab, follow these steps to add lines that should be included in a warranty

agreement:

a. Select Add lineAdd line to add a new condition to the warranty. A sequential line number is automatically

entered in the L ineLine field.

b. In the PeriodPeriod field, select the type of warranty period.

c. In the Inter valInter val  field, enter a number. This field defines the number of periods that the warranty should

be valid for.

d. In the PercentPercent field, enter the coverage percentage for the warranty line. The percentage indicates

how much is covered by your company.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/warranty/warranty-agreement.md
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Set up a warranty on an asset type

Set up a warranty on an asset

This topic explains how to set up warranties on assets and asset types in Asset Management.

1. Select Asset managementAsset management > SetupSetup > Asset typesAsset types  > Asset typesAsset types .

2. In the left pane, select the asset type to attach a vendor warranty agreement to, and then select Asset typeAsset type

defaultsdefaults .

3. On the GeneralGeneral  FastTab, in the Vendor warrantyVendor warranty  field, select the agreement.

1. Select Asset managementAsset management > CommonCommon > AssetsAssets  > All assetsAll assets .

2. Select the asset, and then select EditEdit.

3. On the VendorVendor  FastTab, in the Vendor warrantyVendor warranty  section, in the WarrantyWarranty  field, select the warranty

agreement.

4. In the Warranty star tWarranty star t and Warranty endWarranty end fields, select the start and end dates.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/warranty/warranty-on-assets-and-asset-types.md


NOTENOTE

NOTENOTE

IMPORTANTIMPORTANT
If a date is selected in the Warranty star tWarranty star t  field on a work order, the warranty becomes valid for the work order

on that date. When you create a work order, the Warranty star tWarranty star t  field is automatically set to the date of creation.

However, you can change the date so that it corresponds to, for example, the start date of a warranty agreement.

When you create a work order for an asset that is covered by a vendor warranty, if the work order has an expected start

date during the warranty period, you receive a notification about the warranty agreement. You can then cancel the work

order, as you require.
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Create a maintenance budget

Maintenance budgets are used to provide an overview of expected costs for preventive maintenance. Budget

lines are calculated based on maintenance schedule lines that have an expected start date during the budget

period.

Maintenance budgets are based on the cost types that are used in Asset Management: PreventivePreventive, CorrectiveCorrective,

and InvestmentInvestment. Budget costs for investment maintenance are included for active assets that have a

replacement date during the budget period and a related replacement value. Budget costs for corrective

maintenance are included if a past corrective date is included in the budget calculation. In that case, corrective

costs from an earlier period are calculated for the same future period that you calculate the maintenance budget

for.

NOTENOTE

1. Select Asset managementAsset management > Inquir iesInquir ies  > Maintenance budgetMaintenance budget > BudgetBudget.

2. Select Create budgetCreate budget.

3. In the Maintenance budgetMaintenance budget field, enter a budget ID.

4. In the Descr iptionDescr iption field, enter a description.

5. On the PeriodPeriod FastTab, in the From dateFrom date and To dateTo date fields, enter the start and end dates of the budget

period.

6. To include corrective budget costs that are calculated on the basis of actual costs from a previous period,

in the Corrective from dateCorrective from date field, enter the start date of the period that those costs should be included

from.

7. Depending on the level of detail that is required in the budget, set the relevant options on the five GroupGroup

byby  FastTabs.

8. Select OKOK.

9. Select Budget linesBudget lines  to open Maintenance budget linesMaintenance budget lines  page, where you can view all the budget lines

that have been created for the period.

10. To approve the budget, select it on the Maintenance budgetsMaintenance budgets  page, and then select ApproveApprove. Then, in

the Approve budgetApprove budget dialog box, select OKOK. Your name is entered in the Approved byApproved by  field on the

Maintenance budgetsMaintenance budgets  page.

After you've approved a maintenance budget, you can't recalculate or adjust the related lines on the

Maintenance budget linesMaintenance budget lines page unless you first remove the approval. To remove the approval of a

maintenance budget, select it on the Maintenance budgetsMaintenance budgets page, and then select ApproveApprove. Then, in the

Approve budgetApprove budget  dialog box, select OKOK.
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You can also create a new maintenance budget by copying an existing budget. On the Maintenance budgetsMaintenance budgets

page, select the budget to copy, and then select CopyCopy . This approach is useful if, for example, you've created a

budget for one month and want to copy it to other months.

The maintenance budget calculates only budget costs based on maintenance schedule lines. To calculate actual costs for

the same period, you can do that calculation on the Asset cost controlAsset cost control page.
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Recalculate a maintenance budget

Adjust budget lines

Update actual costs

The Maintenance budget linesMaintenance budget lines  page shows all the budget lines that have been created for the budget that is

selected on the Maintenance budgetsMaintenance budgets  page. (For more information, see Create maintenance budgets.) You can

recalculate and adjust maintenance budget lines until the maintenance budget is approved. After the budget

period has passed, and costs have been posted in Asset Management, you can also update the budget lines with

actual costs.

You can recalculate a maintenance budget on the Maintenance budget linesMaintenance budget lines  page. When you recalculate a

maintenance budget, the existing budget lines are deleted, and a new calculation is done.

1. On the Maintenance budget linesMaintenance budget lines  page, select RecalculateRecalculate.

2. In the Recalculate budgetRecalculate budget dialog box, make the required changes for the new calculation, and then select

OKOK.

New budget lines are created according to the values that you set.

Instead of recalculating the whole maintenance budget, you can adjust selected lines that are related to budget

costs.

1. On the Maintenance budget linesMaintenance budget lines  page, select the lines to update the budget cost for.

2. Select AdjustAdjust.

3. To add an amount to the selected lines, select the Add costAdd cost check box, and then enter the value in the

Add valueAdd value field.

4. To multiply the budget cost on the selected budget lines by a factor, select the Multiply costMultiply cost check box,

and enter the factor in the Multiply valueMultiply value field.

For example, if you enter 1 .21.2  in the Multiply valueMultiply value field, you increase the budget cost on the selected

lines by 20 percent. If you enter 0 .70.7 , you reduce the budget cost on the selected lines by 30 percent.

5. Select OKOK.

The selected budget lines are updated according to the values that you set in step 3 or 4.

After the dates on the budget lines have passed, and actual costs have been posted in Asset Management, you

can update the actual costs on the maintenance budget.

1. On the Maintenance budget linesMaintenance budget lines  page, select Update costUpdate cost.

2. In the Calculate actual costCalculate actual cost dialog box, select OKOK.

The Actual costActual cost fields on the budget lines are updated if actual costs have been posted. New budget lines

might be generated if new asset types have been created since you created the budget, and if those asset types

have been used on assets that work orders have been created for and related costs have been posted for. New

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/maintenance-budgets/update-maintenance-budget.md


NOTENOTE

Manually add budget lines

NOTENOTE

budget lines show only actual costs, because no budget costs were calculated for them.

To see an overview of actual costs divided into preventive, corrective, and investment costs, you can do a calculation for

the same period on the Asset cost controlAsset cost control page.

On the Maintenance budget linesMaintenance budget lines  page, you can manually add a new budget line by selecting NewNew  and then

making selections on the line. Here are some examples of situations where this approach might be useful:

You know that refurbishment of some assets is currently in the planning phase, but related jobs haven't yet

been created in Asset Management. However, you want budget costs for those jobs to be included in the

maintenance budget.

New assets or asset types have been created since you made the maintenance budget, but maintenance

plans haven't yet been set up on those assets or asset types. However, you want budget costs for those asset

types to be included in the maintenance budget.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Cost control for assets, functional locations, and work orders

In Asset Management, you can calculate costs to get an overview of actual costs compared to budget costs on

assets, functional locations, and work orders. Actual costs are based on posted transactions.

You can also make a date calculation if you want to compare scheduled start and end dates to actual start and

end dates on work orders.

The calculations made for assets, functional locations, and work orders are almost identical. The only difference

is that for assets and functional locations, you can also include sub assets and sub locations in your calculation.

The date is the transaction date when the registration was recorded.

1. Click Asset managementAsset management > Inquir iesInquir ies  > AssetsAssets  > Asset cost controlAsset cost control  or Functional location costFunctional location cost

controlcontrol , or Asset managementAsset management > Inquir iesInquir ies  > Work ordersWork orders  > Work order cost controlWork order cost control .

2. In the Asset cost controlAsset cost control  / Functional location cost controlFunctional location cost control  / Work order cost controlWork order cost control  dialog,

select a time range to be calculated.

3. If required, select a financial dimension set to be included in the calculation.

4. Select "Yes" on the Skip zeroSkip zero toggle button if you don't want to show results with a cost of zero.

5. You can use the LevelLevel  field to indicate how detailed you want the cost control lines to be regarding

functional locations.

For example, if you insert the number "1" in the field, and you have a multi-level functional location

hierarchy, all cost control lines for a functional location will be shown on the top level, and therefore the

hours on a line may be added up from functional locations located at a lower level.

If you insert the number "0" in the LevelLevel  field, you will see a detailed result showing all cost control lines

on all the functional location level to which they are related.

6. Select "Yes" on the Show open committed costShow open committed cost toggle button if you want to include that column in the

calculation.

7. Select "Yes" on the Include sub assetsInclude sub assets  toggle button to show costs related to sub assets as separate

lines.

8. If you want to limit the search, you can select specific assets / functional locations / work orders on the

Records to includeRecords to include FastTab.

9. Click OKOK to start the calculation.

The figure below shows an example of the Asset cost controlAsset cost control  dialog.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/controlling-and-reporting/cost-and-date-control.md


Example

10. On the Asset cost controlAsset cost control  page, click the Group byGroup by  buttons to show the required detail level of the

calculation. The selected Group byGroup by  buttons are highlighted. Click on a button to activate or deactivate it.

The screenshot below shows an example of calculation results in Asset cost controlAsset cost control .

The Original budgetOriginal budget field shows budget costs from the work order forecast.

The Committed costCommitted cost field shows the total amount of expenses that a legal entity has committed itself to

pay.

The Open committed costOpen committed cost field shows commitments to pay for items, hours, and services you have

ordered or received but not yet paid for.

The Actual costActual cost field shows related costs after all consumption registrations have been posted.



Work order date control

Example

Another way of making a cost calculation is to multi-select assets in All assetsAll assets  or Active assetsActive assets . Then, you click

the Cost controlCost control  button on the GeneralGeneral  tab. In the Asset cost controlAsset cost control  dialog, the selected assets are

automatically inserted in the AssetAsset field on the Records to includeRecords to include FastTab. Click OKOK, and a cost calculation for

the selected assets is shown. The same procedure can be done for functional locations in All functionalAll functional

locationslocations  or Active functional locationsActive functional locations , and for work orders in All work ordersAll work orders  or Active work ordersActive work orders .

Use this page to get an overview of expected start and end dates compared to actual start and end dates on

work orders.

1. Click Asset managementAsset management > Inquir iesInquir ies  > Work ordersWork orders  > Work order date controlWork order date control .

2. Click CalculateCalculate.

3. Select a functional location in the Functional locationFunctional location field.

4. Insert the range for which you want to make the calculation in the From dateFrom date and To dateTo date fields. All

work orders with expected start date within the range will be included.

5. Click OKOK.

6. Click the Group byGroup by  buttons to show the required detail level of the calculation. The selected Group byGroup by

buttons are highlighted. Click on a button to activate or deactivate it.

The screenshot below shows an example of calculation results in Work order date controlWork order date control .

The Avg. star t delayAvg. star t delay  field shows the difference in days between scheduled start date for a work order

compared to actual start date. If, for example, the actual start date was two days before the scheduled start

date, "-2" will be displayed in this field.

The Avg. end delayAvg. end delay  field shows the difference in days between scheduled end date for a work order

compared to actual end date. If, for example, the actual end date was three days after the scheduled end date,

"3" will be displayed in this field.

The OccurrencesOccurrences  fields show the number of times deviations occur in relation to scheduled and actual start

date, and scheduled and actual end date on the work order.
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Work hour control for assets, functional locations, and work orders

Example

In Asset Management, you can calculate hours to get an overview of actual hours compared to budget hours on

assets, functional locations, or work orders. Actual hours are based on posted transactions.

The calculations made for assets, functional locations, and work orders are almost identical. Only difference is

that for assets and functional locations, you can also include sub assets and sub locations in your calculation.

The date is the transaction date when the registration was recorded.

1. Click Asset managementAsset management > Inquir iesInquir ies  > AssetsAssets  > Asset hour controlAsset hour control  or Functional location hourFunctional location hour

controlcontrol , or Asset managementAsset management > Inquir iesInquir ies  > Work ordersWork orders  > Work order hour controlWork order hour control .

2. In the Asset hour controlAsset hour control  dialog, .

3. In the Asset hour controlAsset hour control  / Functional location hour controlFunctional location hour control  / Work order hour controlWork order hour control  dialog,

select a period to be calculated in the From dateFrom date and To dateTo date fields.

4. If required, select a Financial dimension setFinancial dimension set to be included in the calculation.

5. Select "Yes" on the Skip zeroSkip zero toggle button if you don't want to show results containing zero hours.

6. You can use the LevelLevel  field to indicate how detailed you want the hour control lines to be regarding

functional locations.

For example, if you insert the number "1" in the field, and you have a multi-level functional location

hierarchy, all hour control lines for a functional location will be shown on the top level, and therefore the

hours on a line may be added up from functional locations located at a lower level.

If you insert the number "0" in the LevelLevel  field, you will see a detailed result showing all hour control lines

on all the functional location levels to which they are related.

7. Select "Yes" on the Include sub assetsInclude sub assets  toggle button to show costs related to sub assets as separate

lines.

8. If you want to limit the search, you can select specific assets / functional locations / work orders on the

Records to includeRecords to include FastTab.

9. Click OKOK to start the calculation.

10. On the Asset hour controlAsset hour control  page, click the Group byGroup by  buttons to show the required detail level of the

calculation. The selected Group byGroup by  buttons are highlighted. Click on a button to activate or deactivate it.

The screenshot below shows an example of an Asset hour controlAsset hour control  calculation.

The Original budgetOriginal budget field shows budget hours from the work order forecast.

The Actual hoursActual hours  field shows posted hours on work orders.

The Committed hoursCommitted hours  field shows total amount of hours that your company is committed to in relation to

work orders.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/controlling-and-reporting/work-hour-control.md
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Another way of making an hour calculation is to multi-select assets in All assetsAll assets  or Active assetsActive assets . Then you

click the Hour controlHour control  button on the GeneralGeneral  FastTab. The selected assets are automatically inserted in the

AssetAsset field on the Records to includeRecords to include FastTab. Click OKOK in the Asset hour controlAsset hour control  dialog, and the calculation

for the selected assets is shown. The same procedure can be done for functional locations in All functionalAll functional

locationslocations  or Active functional locationsActive functional locations , and for work orders in All work ordersAll work orders  or Active work ordersActive work orders .

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Example

In Asset Management, you can calculate costs on asset fault registrations to get an overview of actual costs

compared to budget costs. Actual costs are based on posted transactions. The date is the fault date on which the

symptom was recorded.

1. Click Asset managementAsset management > Inquir iesInquir ies  > Asset faultAsset fault > Asset fault cost controlAsset fault cost control .

2. In the Asset fault cost controlAsset fault cost control  dialog, select a financial dimension set to be included in the calculation,

if required.

3. Select "Yes" on the Skip zeroSkip zero toggle button if you don't want to show results with a cost of zero.

4. You can use the LevelLevel  field to indicate how detailed you want the cost control lines to be regarding

functional locations.

For example, if you insert the number "1" in the field, and you have a multi-level functional location

structure, all asset fault cost control lines for a functional location will be shown on the top level, and

therefore the hours on a line may be added up from functional locations located at a lower level.

If you insert the number "0" in the LevelLevel  field, you will see a detailed result showing all asset fault cost

control lines on all the functional location levels to which they are related.

5. If you want to limit the search, you can select specific assets, fault dates, and fault causes on the RecordsRecords

to includeto include FastTab.

6. Click OKOK to start the calculation.

7. Click the Group byGroup by  buttons to show the required detail level of the calculation. The selected Group byGroup by

buttons are highlighted. Click on a button to activate or deactivate it.

This example shows an asset fault cost control calculation.

The Original budgetOriginal budget field shows budget costs from the work order forecast.

The Actual costActual cost field shows posted costs on work orders.

The Committed costCommitted cost field shows total costs that your company is committed to in relation to work

orders.

For information about how to set up faults, see the Fault management topic.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/controlling-and-reporting/asset-fault-cost-control.md
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NOTENOTE

Examples

Group by symptomsGroup by symptoms

In Asset Management, you can analyze asset fault registrations to get an overview of the total number of faults

registered during a specific period. Fault registrations can be analyzed from different perspectives, for example

with focus on assets, asset types, functional locations, fault symptoms, or fault types.

1. Click Asset managementAsset management > Inquir iesInquir ies  > Asset faultAsset fault > Asset fault analysisAsset fault analysis .

2. In the Asset fault analysis calculationAsset fault analysis calculation dialog, you can use the LevelLevel  field to indicate how detailed you

want the asset fault lines to be regarding functional locations.

For example, if you insert the number "1" in the field, and you have a multi-level functional location

structure, all asset fault lines for a functional location will be shown on the top level, and therefore the

hours on a line may be added up from functional locations located at a lower level.

If you insert the number "0" in the LevelLevel  field, you will see a detailed result showing all asset fault lines

on all the functional location level to which they are related.

3. If you want to limit the search, you can select specific assets, fault dates, fault causes, and fault remedies

on the Records to includeRecords to include FastTab.

4. Click OKOK to start the calculation.

5. On the Asset fault analysisAsset fault analysis  tab, click one or more Group byGroup by  buttons to display the detail level you

want to see. Activated buttons are highlighted. Activate or deactivate buttons by clicking on them.

6. Click Update calculationsUpdate calculations  to show your selections on the screen.

Every time you activate or deactivate a Group byGroup by  button, remember to click the Update calculationsUpdate calculations button. This is

required because a large amount of data is processed as you are recalculating fault probability.

There are many ways to analyze fault registrations. This section has five examples of how different data

selections can provide more insight and detail when analyzing asset fault registrations.

In the screenshot below, only the SymptomSymptom button is selected.

Fault registrations have been made on three fault symptoms: "Air leak", "Blown fuse", and "Equipment

jammed".

In the Probability %Probability % column, all percentages add up to 100%. Probability is based on all SymptomSymptom

registrations in this fault analysis.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/controlling-and-reporting/asset-fault-analysis.md


Group by symptoms and time periodGroup by symptoms and time period

Group by multiple symptoms and assetsGroup by multiple symptoms and assets

In the screenshot below, YearYear  and MonthMonth are added to show how you can view fault registrations during a

selected period.

The fault symptoms are now shown as registrations per year/month.

In the Probability %Probability % column, if you add all percentages for each month, they add up to 100%. Probability is

based on the SymptomSymptom registrations in this fault analysis. If you have a large number of lines on an asset,

but a large percentage stands out on a line, that would be an indication of a fault symptom to examine more

closely to find a way to limit the number of registrations for that fault symptom.

The combination of assets and an asset type is used as a basis for the calculations shown in the three

screenshots below, which will increase in detail level.

Generally, the buttons in the Group by dateGroup by date, Group by assetGroup by asset, Group by functional locationGroup by functional location Action Pane

groups, as well as the FaultFault button (Fault ID), contain periods or asset relations. The SymptomSymptom, AreaArea, TypeType,

CauseCause, and RemedyRemedy  buttons are categorizations used in fault management to analyze asset fault registrations



and pinpoint problem areas.

Group by symptom, asset, and asset typeGroup by symptom, asset, and asset type

In the screenshot below, AssetAsset and Asset typeAsset type were added to provide more detail regarding fault registrations.

The fault symptoms are now split up in AssetAsset / Asset typeAsset type / SymptomSymptom combinations.

In the Probability %Probability % column, if you add all percentages for the combination of AssetAsset / Asset typeAsset type /

SymptomSymptom respectively, they each add up to 100%. Probability is based on SymptomSymptom registrations in this

fault analysis. If you have a large number of lines on an asset, but a large percentage stands out on a line,

that would be an indication of a fault symptom to examine more closely to find a way to limit the number of

registrations for that fault symptom.

Group by two symptoms, asset, and asset typeGroup by two symptoms, asset, and asset type

In the screenshot below, AreaArea was added to SymptomSymptom, AssetAsset, and Asset typeAsset type to provide more detail

regarding fault registrations.

In the Probability %Probability % column, if you add all percentages for the combination of AssetAsset / Asset typeAsset type /

SymptomSymptom on an asset, they each add up to 100%. Probability is based on the combination of SymptomSymptom and

AreaArea in this fault analysis. If you have a large number of lines on an asset, but a large percentage stands out

on a line, that would be an indication of a fault area to examine more closely to find a way to limit the

number of registrations for that fault area.



NOTENOTE

NOTENOTE

Group by three symptom, asset, and asset typeGroup by three symptom, asset, and asset type

In the screenshot below, TypeType was added, and the most detailed calculation in this example is shown.

In the Probability %Probability % column, if you add all percentages for the combination of AssetAsset / Asset typeAsset type /

SymptomSymptom on an asset, they each add up to 100%. Probability is based on the combination of SymptomSymptom,

AreaArea, and TypeType in this fault analysis. If you have a large number of lines on an asset, but a large percentage

stands out on a line, that would be an indication of a fault type to examine more closely to find a way to limit

the number of registrations on that fault type.

For an overview of all fault registrations created on work orders and maintenance requests, click Asset managementAsset management  >

InquiriesInquiries  > Asset faultAsset fault  > Asset faultsAsset faults . On the Asset faultsAsset faults  page, select an asset fault registration and expand the

Related informationRelated information pane to see information regarding the related work order or maintenance request.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Asset Asset ID.

Total time Total time set up in the calendar used in the calculation. If
the asset is related to a resource, the related resource
calendar is used. If the asset isn't related to a resource, the
calendar selected in the Standard calendarStandard calendar  field in AssetAsset
management parametersmanagement parameters  is used.

Uptime Total time minus downtime.

Downtime Maintenance downtime registrations made on the asset in
the selected period.

Repair time Total number of work hours consumed on repair work
orders.

Availability % Uptime divided by total time and multiplied by 100.

Number of faults Number of fault causes registered on fault symptoms on the
asset in the selected period.

MTBF Mean Time Between Failure, which is total time divided by
number of faults registered on the asset in the selected
period. If number of faults is zero, MTBF is set to total time.

In Asset Management, you can calculate various Key Performance Indicators (KPIs) for assets and asset types.

You use KPIs to get an overview of performance on assets in relation to, for example, uptime, downtime, repair

time, and Mean Time Between Failure (MTBF).

1. Click Asset managementAsset management > Inquir iesInquir ies  > AssetsAssets  > Asset KPIsAsset KPIs .

2. In the Calculate asset KPIsCalculate asset KPIs  dialog, you select the Time scaleTime scale to be used in the calcualtion, and a period

in the From dateFrom date and To dateTo date fields.

3. On the Records to includeRecords to include FastTab, you can select specific assets and asset types to be included in the

calculation, if required.

4. Click OKOK to start the calculation.

5. On the Over viewOver view  FastTab, the results of the calculation are displayed in grid view. Each asset is displayed

on a separate line.

6. On the KPIs for selected lineKPIs for selected line FastTab, you see calculations for the asset selected on the Over viewOver view

FastTab. The KPI values are categorized regarding TimeTime, AvailabilityAvailability , Work ordersWork orders , MaintenanceMaintenance,

FaultsFaults , Maintenance downtimeMaintenance downtime, and CostCost.

In the table below, you'll find a description of the fields on the Asset KPIsAsset KPIs  page.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/controlling-and-reporting/asset-kpis.md


Fail rate 1 divided by MTBF.

MRT Mean Repair Time, which is repair time divided by number of
faults registered on the asset in the selected period. If
number of faults is zero, MRT is set to repair time.

Number of stops Number of maintenance downtime registrations created on
the asset.

MTBS Mean Time Between Stops, which is total time divided by
number of maintenance downtime registrations. If number
of maintenance downtime registrations is zero in the
selected period, the MTBS value is set to total time.

Preventive cost Costs posted on the asset related to cost type "Preventive"
in the selected period. Cost types are set up on work order
types.

Corrective cost Costs posted on the asset related to cost type "Corrective" in
the selected period. Cost types are set up on work order
types.

Replacement value Value defined on the asset as the replacement cost.

Asset type Identification of the asset type selected on the asset.

Manufacturer Identification of the manufacturer selected on the asset.

Model Identification of the manufacturer model selected on the
asset.

From date Start date of the KPI calculation. If the asset was created
after the start date selected for the calculation, the start
date of the asset is shown in this field.

To date End date of the KPI calculation. If the asset was registered as
inactive before the end date selected for the calculation, the
date from which the asset was no longer active is shown in
this field.

Time scale During calculation of the KPIs, you select a time scale to be
used: Hours, Days, or Weeks.

Availability Uptime divided by total time.

Work orders Total number of work orders included in the KPI calculation.

Work order time Total number of work hours consumed on the work orders.

Primary work orders Number of primary work orders included in the KPI
calculation.

Secondary work orders Number of secondary work orders included in the KPI
calculation.
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Maintenance work orders Number of maintenance work orders included in the KPI
calculation. A maintenance work order is a work order with
no related fault causes.

Maintenance time Total number of work hours consumed on maintenance work
orders.

Repair work orders Number of repair work orders included in the KPI calculation.
A repair work order is a work order with a related fault
cause.

Reliability % Calculation based on the expected exponential development
in fault registrations on an asset meaning that, over time,
the asset becomes less reliable due to wear and tear. The
calculation of this KPI is based on MTBF and total time.

MTPS Mean Time Production Stops, which is maintenance
downtime divided by number of maintenance downtime
registrations. If number of maintenance downtime
registrations is zero in the selected period, the MTPS value is
set to zero.

Total cost Total costs posted on the asset in the selected period.

Investment cost Costs posted on the asset related to cost type "Investment"
in the selected period. Cost types are set up on work order
types.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

The figure below shows a screenshot of a KPI calculation for four assets.

You can multi-select several assets in All assetsAll assets  and click the Asset KPIsAsset KPIs  button on the GeneralGeneral  tab. Then



NOTENOTE

click OKOK in the Calculate asset KPIsCalculate asset KPIs  dialog to calculate KPIs for the selected assets.

Results from a KPI calculation may or may not include maintenance downtime registrations, depending on

the setup and use of maintenance downtime reason codes.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Make an item-where-used calculation

Example

You can make a calculation for a specific item to get an overview of where in Asset Management the item has

been used. The results show the context in which the item has been used during its lifetime. The Item whereItem where

usedused page can be opened from the main Asset Management menu, and it can also be accessed from the

following pages:

Asset BOMs

Spare parts on asset type defaults

Maintenance job type categories and maintenance job types, maintenance job type variants, maintenance

job trades, and maintenance checklists

Maintenance forecast

Procurement

Work order purchase

1. Click Asset managementAsset management > Inquir iesInquir ies  > Item where usedItem where used, or select the Item where usedItem where used button on

one of the pages mentioned above.

2. In the Item where usedItem where used dialog, select the item for which you want to make the calculation in the ItemItem

numbernumber  field.

3. You can use the LevelLevel  field to indicate how detailed you want the item lines to be regarding functional

locations.

For example, if you insert the number "1" in the field, and you have a multi-level functional location

structure, all item lines for a functional location will be shown on the top level. Therefore,

relation/quantity on a line may be added up from functional locations located at a lower level.

If you insert the number "0" in the LevelLevel  field, you will see a detailed result showing all item lines on all

the functional location levels to which they are related.

4. In the IncludeInclude section, select "Yes" on the toggle buttons that you want to include in the calculation.

5. Click OKOK to start the calculation.

6. On the Item where usedItem where used tab, select the Group byGroup by  buttons to show the required detail level of the

calculation. The selected Group byGroup by  buttons are highlighted. Click on a button to activate or deactivate it.

7. If you want to show dimensions related to the item, click Display dimensionsDisplay dimensions , and select the

dimensions to be shown.

In the screenshot below, you see an example of an item-where-used calculation for item number "1000".

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/controlling-and-reporting/item-where-used.md
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Make a maintenance status calculation

NOTENOTE

Example 1

In Asset Management, you can make an overview calculation for a specific period for new, active, and completed

maintenance requests, work orders, and maintenance downtime activities. You can also see the number of

completed condition assessments for the same period. Use this calculation to get an overview of workload for

incoming and completed maintenance requests and work orders.

1. Click Asset managementAsset management > Inquir iesInquir ies  > Maintenance statusMaintenance status .

2. In the Calculate statusCalculate status  dialog, select the time range that you want to make the calculation in the FromFrom

datedate and To dateTo date fields.

3. You can use the LevelLevel  field to indicate how detailed you want the maintenance lines to be regarding

functional locations.

For example, if you insert the number "1" in the field, and you have a multi-level functional location structure, all

maintenance lines for a functional location will be shown on the top level, and therefore the status on a line may

be added up from functional locations located at a lower level.

If you insert the number "0" in the LevelLevel  field, you see a detailed result showing all maintenance lines on all the

functional location levels to which they are related.

4. Click OKOK to start the calculation.

5. Click the Group byGroup by  buttons to show the required detail level of the calculation. The selected Group byGroup by

buttons are highlighted. Click on a button to activate or deactivate it.

6. Remember to click the UpdateUpdate button to update the calculation each time you make changes by

activating or deactivating Group byGroup by  buttons, or by making a calculation for a new period.

7. Click StatusStatus  if you want to create a new maintenance status calculation.

The results shown in Maintenance statusMaintenance status only include maintenance requests and work orders that have an actual start

date and time. End date and time may be blank.

In the screenshot below, the YearYear  and MonthMonth buttons have been activated. With these Group byGroup by  options

selected, you get a general overview on a monthly basis of workload and throughput related to maintenance

requests and work orders.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/controlling-and-reporting/maintenance-status.md


Example 2

NOTENOTE

In the screenshot below, information about functional locations has been added. Now it is possible to compare

workload and throughput across functional locations, which may represent geographical locations, factories, or

work areas.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Set up the Asset management mobile workspace
2/18/2021 • 3 minutes to read • Edit Online

Set up maintenance worker users in Supply Chain Management

NOTENOTE

Publish the Asset management mobile workspace

This topic describes how to set up Microsoft Dynamics 365 Supply Chain Management and the Finance and

Operations (Dynamics 365) mobile app to run an Asset managementAsset management mobile workspace that workers can use

to perform asset management tasks.

For each user that requires access to the Asset managementAsset management mobile workspace, follow these steps.

1. In Supply Chain Management, go to Human resources > WorkersHuman resources > Workers , and make sure that a worker record

exists for the user that you want to set up. Create a new worker record as required.

2. Go to Asset management > Setup > Workers > WorkersAsset management > Setup > Workers > Workers , and make sure that the worker record that

you identified (or created) in the previous step is mapped to a maintenance worker record. Create a new

maintenance worker record as required, and set the WorkerWorker  field to the worker record from the previous

step.

3. Go to Asset management > Setup > Workers > Maintenance worker groupsAsset management > Setup > Workers > Maintenance worker groups , and make sure that

the maintenance worker record that you identified (or created) in the previous step belongs to a maintenance

worker group.

4. Go to System administration > UsersSystem administration > Users .

5. Select the relevant user in the grid.

6. On the User DetailsUser Details  FastTab, set the PersonPerson field to the worker account that you want to associate with the

current user account. This worker account should be the worker record that you identified (or created) in step

1 and mapped to a maintenance worker record in step 2.

User permissions and security roles apply to the features of the Asset managementAsset management  mobile workspace just as they

apply to the features of the Supply Chain Management user interface. Therefore, every user that you set up to access the

Asset managementAsset management  mobile workspace must have the security roles that are required to perform similar operations

directly in Supply Chain Management.

To make asset management features available in the Finance and Operations (Dynamics 365) mobile app, you

must publish the Asset managementAsset management mobile workspace.

1. In Supply Chain Management, select the SettingsSettings  button (the gear symbol in upper-right corner), and

then select Mobile appMobile app on the menu.

2. In the Manage mobile appManage mobile app dialog box, find the Asset ManagementAsset Management tile. If it contains the text "In

metadata - not published," the workspace hasn't yet been published. If it contains the text "In metadata -

published," the workspace has already been published, and you can skip the rest of this procedure.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/set-up-asset-management-mobile.md


Install and set up the Finance and Operations (Dynamics 365) mobile
app

3. Select the Asset ManagementAsset Management tile, and then select PublishPublish on the toolbar. After a few seconds, you

should receive a notification that states that the workspace has been successfully published. Additionally,

the text on the tile should change to "In metadata - published."

1. Go to one of the following app stores to install the Microsoft Finance and Operations (DynamicsMicrosoft Finance and Operations (Dynamics

365)365)  app on your mobile device:

For Google Android devices

For Apple iOS devices

2. Open the Finance and Operations (Dynamics 365) app. The sign-in page should appear. In the S ign inSign in

field, enter your Supply Chain Management URL, or select a recent URL in the Recent environmentsRecent environments

list, and then tap ConnectConnect.

https://go.microsoft.com/fwlink/?linkid=850662
https://go.microsoft.com/fwlink/?linkid=850663


3. If you're prompted to confirm the connection, select the I understandI understand check box, and then tap ConnectConnect.

4. On the Pick an accountPick an account page, use your Microsoft account to sign in to the mobile application.

The WorkspacesWorkspaces  page appears. It lists every mobile workspace that has been published by your Supply

Chain Management instance.

5. If you must change the legal entity (company), tap the Menu button (sometimes referred to as the

hamburger or the hamburger button) in the upper-left corner, and then tap Change companyChange company .

6. On the WorkspacesWorkspaces  page, select the workspace that you want to work with to open it.



Work with the Asset management mobile workspace

NOTENOTE

For more information about how to work with the Asset managementAsset management mobile workspace, see Use the Asset

management mobile workspace.

For more information about the Finance and Operations (Dynamics 365) mobile app, see the Mobile app home

page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Use the Asset management mobile workspace
2/18/2021 • 6 minutes to read • Edit Online

Overview

Prerequisites

Download and install the mobile app

Sign in to the mobile app

This topic provides information about the Asset managementAsset management mobile workspace. This workspace lets users

view and create maintenance requests and work orders. Users can also view the assigned work order jobs in a

calendar or list view. Assets and functional locations can also be viewed and searched for.

Asset Management is an advanced module for managing assets and work order jobs in Dynamics 365 Supply

Chain Management. The Asset managementAsset management mobile workspace lets users quickly view assigned work order

jobs on the mobile device of their choice. Users can also create and manage maintenance requests, update

lifecycle state, and view asset and functional location details by using their mobile device.

Specifically, the Asset managementAsset management mobile workspace lets users perform these tasks:

Create, view, and edit maintenance requests, take a photo or attach an existing image to the maintenance

request, change the maintenance request lifecycle state.

Create, view, and edit work orders, take a photo or attach an existing image to the work order, change the

work order lifecycle state, view work order jobs.

View assigned work order jobs in a calendar view.

Create, view, and edit work order job, update asset counters, view maintenance checklist, view and edit work

order job notes, view the tools required for the work order job.

View or search for a specific asset or functional location.

Before you can use the Asset managementAsset management mobile workspace, your admin must set up the required user and

worker accounts, and publish the workspace. For more information, see Set up the Asset management mobile

workspace.

Download and install the Dynamics 365 for Unified Operations mobile app:

For Android phones

For iPhones

1. Start the app on your mobile device.

2. Enter your Dynamics 365 URL.

3. The first time that you sign in, you're prompted for your user name and password. Enter your credentials.

4. After you sign in, the available workspaces for your company are shown. Note that if your system

administrator publishes a new workspace later, you'll have to refresh the list of mobile workspaces.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/asset-management-mobile-workspace.md
https://go.microsoft.com/fwlink/?linkid=850662
https://go.microsoft.com/fwlink/?linkid=850663


View assigned work order jobs in calendar view

Create a work order job

1. On your mobile device, open the Asset managementAsset management workspace.

2. Select My work order jobs calendarMy work order jobs calendar .

3. Select the date you want to view work order jobs for. In the list, you'll see the asset ID and functional

location ID for each work order job.

4. Select a work order job in the list to see job details: Asset and functional location details as well as other

navigation links to view AttachmentsAttachments , ChecklistsChecklists , ToolsTools , Asset countersAsset counters , NotesNotes , JournalsJournals .

1. On your mobile device, open the Asset managementAsset management workspace.

2. Select All maintenance work ordersAll maintenance work orders .

3. Select the work order you want to create a new work order job for.



Add attachment to a work order job

4. Select the Add lineAdd line button.

5. Select the AssetAsset you want to create a work order job for.

6. Select Maintenance job typeMaintenance job type, Maintenance job type var iantMaintenance job type var iant and TradeTrade.

7. Select DoneDone.

1. On your mobile device, open the Asset managementAsset management workspace.

2. Select All maintenance work ordersAll maintenance work orders .

3. Select the work order > work order job you want to add an attachment to.

Alternatively, you can also select My work order jobs calendarMy work order jobs calendar  or My work order jobs listMy work order jobs list on the

home page to navigate to the Work order job detailsWork order job details  page.

4. Select AttachmentsAttachments  on the Work order job detailsWork order job details  page.

5. You'll see existing attachments on the work order job. Select Add attachmentAdd attachment.

6. Enter NameName and NotesNotes  for the attachment.

7. Select Choose imageChoose image to select a photo from the mobile gallery, or Take photoTake photo to take a photo.

8. Select DoneDone.



View maintenance checklist on a work order job
1. On your mobile device, open the Asset managementAsset management workspace.

2. Select All maintenance work ordersAll maintenance work orders .

3. Select the work order > work order job you want to view checklists for.

Alternatively, you can also select My work order jobs calendarMy work order jobs calendar  or My work order jobs listMy work order jobs list on the

home page to navigate to the work order job detailswork order job details  page.

4. Select ChecklistsChecklists  on the Work order job detailsWork order job details  page.

5. You'll see a list of checklist lines related to the work order job. Select a checklist line to view InstructionsInstructions

and add NotesNotes .

6. Select the back button (<<) to return to the previous page.



View and update asset counters on a work order job
1. On your mobile device, open the Asset managementAsset management workspace.

2. Select All maintenance work ordersAll maintenance work orders .

3. Select the work order > work order job you want to view asset counters for.

Alternatively, you can also select My work order jobs calendarMy work order jobs calendar  or My work order jobs listMy work order jobs list on the

home page to navigate to the work order job detailswork order job details  page.

4. Select Asset countersAsset counters  on the Work order job detailsWork order job details  page.

5. You see a list of asset counters related to the work order job. Select the pencil icon on an asset counter

line to update the counter value.

6. Enter a new counter value, and select DoneDone.



Register consumption on a work order job
1. On your mobile device, open the Asset managementAsset management workspace.

2. Select All maintenance work ordersAll maintenance work orders .

3. Select the work order > work order job you want to add consumption registrations for.

Alternatively, you can also select My work order jobs calendarMy work order jobs calendar  or My work order jobs listMy work order jobs list on the

home page to navigate to the work order job detailswork order job details  page.

4. Select JournalsJournals  on the Work order job detailsWork order job details  page.

5. Select Add hoursAdd hours  to create work hour registrations.

a. Select the Categor yCategor y  from the lookup.

b. In the HoursHours  field, enter the number of work hours spent on the work order job.

c. Select the appropriate L ine proper tyLine proper ty .

d. Select DoneDone.

6. Select Add itemsAdd items to create item registrations.

a. Select the Item numberItem number  from the lookup.

b. Select the S iteSite from the lookup.

c. Enter the QuantityQuantity  of items consumed.

d. Select DoneDone.

7. Select Add expenseAdd expense to create expense registrations.

a. Select the Categor yCategor y  from the lookup.

b. Enter the quantity for the expense registration.

c. Select the Sales currencySales currency  from the lookup.

d. Enter the Cost pr iceCost pr ice for the expense registration.



Update lifecycle state on a work order

e. Select DoneDone.

1. On your mobile device, open the Asset managementAsset management workspace.

2. Select All maintenance work ordersAll maintenance work orders .

3. Select the work order you want to update lifecycle state for.

4. Select the Update stateUpdate state button at the bottom of the screen.

5. Select a new lifecycle state from the list.

6. Select DoneDone.



Create a maintenance request
1. On your mobile device, open the Asset managementAsset management workspace.

2. Select All maintenance requestsAll maintenance requests .

3. Select ActionsActions  at the bottom of the screen, and select Create maintenance requestCreate maintenance request.

4. If number sequence is enabled for maintenance requests in Asset managementAsset management, the MaintenanceMaintenance

requestrequest field is hidden because it is automatically filled out. If the Maintenance requestMaintenance request field is visible,

enter a maintenance request ID.

5. Select a Maintenance request typeMaintenance request type.

6. Enter a Descr iptionDescr iption for the maintenance request.

7. Select the AssetAsset you want to create the request for.

8. Select the Ser vice levelSer vice level  for the maintenance request.

9. Select DoneDone.



Add attachment to a maintenance request
1. On your mobile device, open the Asset managementAsset management workspace.

2. Select All maintenance requestsAll maintenance requests .

3. Select the maintenance request you want to add an attachment to.

4. Select AttachmentsAttachments  at the bottom of the screen.

5. Select Add attachmentsAdd attachments .

6. Enter NameName and NotesNotes  for the attachment.

7. Select Choose imageChoose image to select a photo from the mobile gallery or Take photoTake photo to take a photo.

8. Select DoneDone.



NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Integrate Dynamics 365 Supply Chain Management
(Asset management) with Dynamics 365 Guides
2/18/2021 • 3 minutes to read • Edit Online

Prerequisites

Use Dynamics 365 Guides with Asset management

Associate a guide with a maintenance checklist templateAssociate a guide with a maintenance checklist template

You can integrate the Asset managementAsset management module in Microsoft Dynamics 365 Supply Chain Management with

Dynamics 365 Guides to take advantage of mixed-reality guides in your day-to-day service and maintenance

workflows. If a guide is associated with an Asset Management work order, a worker who opens the work order's

maintenance checklist in the Supply Chain Management (Dynamics 365) mobile app sees that a guide is

available. The worker can then find and open the guide in the Dynamics 365 Guides HoloLens app.

Before you can attach guides to Asset management work orders, you must complete these prerequisites:

Set up Dynamics 365 Supply Chain Management version 10.0.9 or later.

Turn on dual-write for Supply Chain Management apps.

Turn on flight for the MRGuidesFeatureMRGuidesFeature feature. (For production environments, you must first submit a

support ticket to have your tenant added to the flighting group.)

Turn on the following configuration keys on the L icense configurationLicense configuration page:

Asset management > Asset management mixed reality

Mixed reality > Mixed reality guide

Set up Dynamics 365 Guides version 200.0.0.96 or later.

To associate a guide, you use a maintenance checklist line in Asset management. You can create the association

through a maintenance checklist template, a maintenance job type, or a work order, because all three contain

maintenance checklist lines. You can save time by using a template, because a template can be associated with

all the maintenance job types that use it. For example, a guide that is associated with a maintenance job type is

automatically associated with all work orders that specify that job type. On the other hand, a guide that is

associated directly with a work order exists only for that work order.

To associate a guide with a maintenance checklist template, follow these steps.

1. Create a guide by using the Dynamics 365 Guides PC and HoloLens apps. For information about how to

create a guide, see the following topics:

Use the PC app to create a guide

Use the HoloLens app to place your holograms

2. In Supply Chain Management, create a maintenance checklist template.

3. Associate the guide that you created with a maintenance checklist line in the new maintenance checklist

template:

a. On the Maintenance checklist linesMaintenance checklist lines  FastTab, select the line that you want to associate the guide

with.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/asset-management-guides-integration.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/index
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/dual-write/enable-dual-write
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/data-entities-data-packages
https://docs.microsoft.com/en-us/dynamicsax-2012/appuser-itpro/license-code-and-configuration-key-reference
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/setup#step-2-create-a-common-data-service-environment-and-install-the-dynamics-365-guides-solution
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/pc-app-overview
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/hololens-app-overview


b. On the Associated guidesAssociated guides  FastTab, select Add GuideAdd Guide.

c. In the NameName field, select a guide, and then select SaveSave.

4. Associate the maintenance checklist template with a job type:

a. Create a maintenance job type, or select an existing maintenance job type.

b. On the Action Pane, select Maintenance job type defaultsMaintenance job type defaults .



c. Create a line, and then select SaveSave.

d. On the Action Pane, select Maintenance checklistMaintenance checklist.

e. On the Maintenance checklist linesMaintenance checklist lines  FastTab, add a line, and then change the value of the TypeType

field to TemplateTemplate.

f. On the L ine detailsL ine details  FastTab, in the TemplateTemplate field, select the template that you associated the

guide with, and then select SaveSave.



5. Create a work order, and then select the maintenance job type that uses the maintenance checklist

template that you associated the guide with. The guide is automatically associated with the work order.

6. View the guide that is associated with the work order and workers:

a. Open the Asset management mobile workspace to access the work order.

b. Open the maintenance checklist for the work order.

c. Select a checklist line to see the associated guide.



NOTENOTE

IMPORTANTIMPORTANT

See also

NOTENOTE

d. Open the guide on HoloLens.

You can also associate a guide directly in the maintenance checklist of a work order or a job type.

There is a known issue where, when you associate a maintenance checklist template with a default maintenance job type,

the guide that is linked to the template doesn't appear on the Associated guidesAssociated guides FastTab of the Maintenance jobMaintenance job

type defaultstype defaults  page. However, the guide will appear after that job type is applied to a work order on the AssociatedAssociated

guidesguides FastTab.

Dual-write overview

Asset management overview

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/dual-write/dual-write-overview
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Target entities
2/18/2021 • 2 minutes to read • Edit Online

In the Data managementData management workspace, you can get an overview of target entities, related entity types and

staging tables related to the Asset managementAsset management module.

1. Click the Finance and OperationsFinance and Operations  button in the upper-left corner of the screen, and click DataData

managementmanagement.

2. In the Impor t / Expor tImpor t / Expor t section, click Data entitiesData entities .

3. On the Target entitiesTarget entities  page, search for "asset management" in the filter, and press Enter to see a list of

the entities related to Asset management.

The figure below shows some of the Asset management entities.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/data-management/target-entities.md


NOTENOTE

4. Select an entity and click Modify target mappingModify target mapping.

5. On the Map staging to targetMap staging to target page, you see a list of the staging fields related to the selected entity.

Click Mapping visualizationMapping visualization to see a graphic overview of how staging data and target data are related.

In the figure below, a visualization of the fields related to the asset types entity is shown.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


 

Cost accounting home page
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Learning map

Quick links

Configure base entities (eLearning) (requires
CustomerSource account)

Cost element dimensions

Dimension hierarchy Define cost control units

Allocation bases Create and assign a cost allocation policy to a cost control
unit

Manage a data source for the cost accounting ledger Process and trace source data

Overhead calculation Cost control workspace

Get started videos

The following learning map shows the major concepts and tasks that make up the framework of the Cost

accounting module. Click the links in the Quick links section to learn how to use the module.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/cost-accounting-home-page.md
file:///T:/eiye/ac1a/dynamics365/finance/cost-accounting/media/cost-accounting-map.png
https://mbspartner.microsoft.com/Home


Get started with cost accounting Cost accounting mobile workspace Use Excel for cost accounting analysis

NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://www.youtube.com/watch?v=1pUDtJQZ8FU&t=35s
https://www.youtube.com/watch?v=imsuTg8rUVk&t=7s
https://www.youtube.com/watch?v=-HKHYdClvx8
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Cost accounting terminology
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This topic defines the key terms that are used in Cost accounting.

Allocation baseAllocation base

The allocation base is used to measure and quantify activities, such as machine hours that are used, kilowatt

hours that are consumed, or square footage that is occupied. It's used as basis for allocating costs to one or

more cost objects

Cost accountingCost accounting

Cost accounting lets you collect data from various sources, such as the general ledger, sub-ledgers, budgets, and

statistical information. You can then analyze, summarize, and evaluate cost data, so that management can make

the best possible decisions for price updates, budgets, cost control, and so on. The source data that is used for

cost analysis is treated independently in Cost accounting. Therefore, updates in Cost accounting don’t affect the

source data. However, when you collect cost data from various sources, and especially when you import the

main accounts from General ledger as cost elements, there is data redundancy, because the same data exists in

both General ledger and Cost accounting. This redundancy is required, because you use financial management

for external reporting and Cost accounting for internal reporting.

Cost accounting ledgerCost accounting ledger

Defined by calendar, currency, and cost element dimension, it controls processes and policies for measuring

costs.

Cost entr yCost entr y

Cost entries are the result of a transfer via data connectors from general ledger entries, cost allocations, and

posted cost entries in cost journals.

Cost objectCost object

Any type of object that is selected for cost control. Costs or revenues are either directly posted on or allocated to

cost objects. Some typical cost objects are:

Products

Projects

Departments

Cost centers

Management uses cost objects to quantify costs, but also to drive profitability analysis.

Cost elementCost element

Used as a function to track and categorize costs. There are two types of cost elements: primary and secondary.

Primary cost elements represent the cost flow from financial accounting to Cost accounting. The structure

typically corresponds to the profit and loss account structure in the general ledger where a cost element can

correspond to a main account. Not all main accounts must be represented as cost elements, depending on

business requirements.

Secondary cost elements represent the internal cost flow because these costs are only used in Cost accounting.

They are used in cost roll-up rules to aggregate costs into meaningful buckets used by overhead calculation.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/terms-cost-accounting.md


Cost classificationCost classification

Cost classification groups costs according to their shared characteristics. For example, costs can be grouped by

elements, traceability, and behavior.

By elementsBy elements  – Materials, labor, and expenses.

By traceabilityBy traceability  – Direct costs and indirect costs. Direct costs are assigned directly to cost objects. Indirect

costs aren't directly traceable to cost objects. Indirect costs are allocated to cost objects.

By behaviorBy behavior  – Fixed, variable, and semi-variable.

Cost behaviorCost behavior

Cost behavior classifies costs according to their behavior in relation to changes in key business activities. To

control costs effectively, management must understand the cost behavior. There are three types of cost behavior

pattern: fixed, variable, and semi-variable.

Fixed costFixed cost - A fixed cost is a cost that doesn't vary in the short term, regardless of changes in activity

level. For example, a fixed cost can be a basic operating expense of a business, such as rent, that won't be

affected even if the activity level increases or decreases.

Var iable costVariable cost - A variable cost changes according to changes in activity level. For example, a specific

direct materials cost is associated with each product that is sold. The more products that are sold, the

more direct materials costs there are.

Semi-var iable costSemi-var iable cost - Semi-variable costs are partly fixed and partly variable costs. For example, an

Internet access fee includes a standard monthly access fee and a broadband usage fee. The standard

monthly access fee is a fixed cost, whereas the broadband usage fee is a variable cost.

Cost control unitCost control unit

The cost control unit represents the cost structure. The structure determines how cost flows in a hierarchical

order between cost object dimensions and their respective cost objects.

Cost distr ibutionCost distr ibution

Is used to distribute cost from one cost object to one or more other cost objects by applying a relevant

allocation base. Cost distribution and cost allocation differ in that cost distribution always occurs at the level of

the primary cost element of the original cost and no reciprocal processing.

Cost allocationCost allocation

Is used to allocate the balance of a cost object to other cost objects by applying an allocation base. Finance

supports the reciprocal allocation method. In the reciprocal allocation method, the mutual services that auxiliary

cost objects exchange are fully recognized. The system automatically determines the order to perform the

allocations in and iterate over it. The balance of a cost object is allocated by a single allocation base. Allocations

across cost object dimensions and their respective members are supported. The allocation order is controlled by

the cost control unit.

Cost allocation policyCost allocation policy

A cost allocation policy defines the amounts and quantities that must be allocated. Allocation rules include

allocation source rules, which determine the costs that are allocated, and allocation targets rules, which

determine where the costs are allocated. For example, all costs for facility services are an allocation source that

can be allocated to various departments in an organization (that is, to allocation targets).

Cost roll-upCost roll-up

The purpose of cost roll-up rules is to aggregate costs into meaningful buckets. The level of aggregation is user-

defined and involves the assignment of a secondary cost element. If cost roll-up is not used, every element of a



DATA  SO URC ESDATA  SO URC ES
IM P O RT ED T RA N SA C T IO N SIM P O RT ED T RA N SA C T IO N S
DATA  C O N N EC TO RDATA  C O N N EC TO R

DY N A M IC S 365 F IN A N C EDY N A M IC S 365 F IN A N C E
DATA  C O N N EC TO RDATA  C O N N EC TO R

DY N A M IC S A X  DATADY N A M IC S A X  DATA
C O N N EC TO RC O N N EC TO R

Cost element dimension
members

Yes Yes Yes

Cost object dimension
members

Yes Yes Yes

Statistical dimension
members

Yes No No

General ledger Yes Yes Yes

Budget entries Yes Yes Yes

Statistical measures Yes Yes Yes

cost is allocated from one cost object to another

Cost rate policyCost rate policy

The cost rate is used to calculate price per cost object. To understand the elements of the price, you define cost

rate policies. There are two types of cost rate: historical cost rate and planned cost rate. A historical cost rate is a

calculated rate that is used as a multiplier for the allocation base of a cost object. The rate is calculated based on

the cost allocations in the previous period. A planned rate is a user-defined rate.

Dimension hierarchyDimension hierarchy

There are two dimension hierarchies: categorization hierarchy and classification hierarchy. The dimension

categorization hierarchy type is used for reporting purposes. It supports only the cost element dimensions. The

dimension classification hierarchy type is used to define policies and for reporting purposes. It supports all

dimensions, such as cost objects, cost elements, and statistical dimensions.

Data connectorData connector

Cost accounting supports integration of data from source systems via a set of data connectors. The following

data connectors are available:

Imported transactions (pre-configured)

Dynamics 365 Finance (pre-configured)

Dynamics AX (configuration required)

Note:Note: The data connector Imported transactions is based on data entities.

Data providerData provider

Most source systems can provide data that matches one or more data sources in Cost accounting. To align data

from the source systems with the data source in Cost accounting, a data provider needs to be configured. The

following table lists the availability of data providers per data connector and data source.

FormulaFormula

Formula allocation bases let you define advanced formulas to achieve the correct allocation basis. You can

manually create formula allocation bases. You can use the following operators to define your formula.



SY M B O L SSY M B O L S T EXTT EXT

( ) Parentheses

< Smaller than

> Larger than

+ Addition

– Subtraction

* Multiplication

STAT EM EN T  STAT EM EN T  VA L IDAT IO NVA L IDAT IO N RESULTRESULT

a > b True

a > b False

Traditional IF statements are not supported. However, you can create statements and validate whether they are

true.

Overhead costOverhead cost

Overhead costs refer to the ongoing expenses of operating a business. They are the costs that can’t be linked

directly to specific business activities. Here are some examples of overhead costs:

Accounting fees

Depreciations

Insurance

Interest

Legal fees

Taxes

Utilities costs

Overhead rateOverhead rate

Rates are defined per cost object and cost element. There are two types of rates: fiscal period and user-specified.

Fiscal period rates are calculated by the overhead calculation. A user-specific rate is user-defined and can be

used to allocate cost between cost objects at a predetermined rate in the overhead calculation.

PublishedPublished

If you set this field to Yes, a user who is assigned one of the following roles can view the report in the Cost

control workspace:

Cost accounting manager

Cost accountant

Cost accountant clerk

Cost object controller

If you set this field to No, only users who are assigned one of the following roles can view the report in the Cost

control workspace:
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Cost accounting manager

Cost accountant

Cost accountant clerk

Statistical dimensionStatistical dimension

A statistical dimension and its members are used to register and control non-monetary entries in Cost

accounting. Statistical dimension members can be used for two purposes:

As an allocation base in policies such as cost distribution or cost allocation.

For reporting of non-monetary consumption.

A statistical dimension is the expression of a count or sum of an activity that can be used as the basis for

allocations or rate calculations. It's either created manually or imported from source systems. Examples of

statistical dimensions include the number of employees, the count of licensed software on each device, power

consumption of each machine, or square meters for a cost center.

StatementStatement

Statements are views for the managers who are responsible for controlling costs. Statements are defined by a

cost controller, and they provide a quick overview of actual costs, budgeted costs, and deviations. A manager can

drill further into details if required. To help ensure that managers view only data that they are accountable for,

data that appears in the statements is subject to access rules.

VersionVersion

Versions are used to simulate, view, and compare various outcomes. By default, all actual costs are viewed in one

base version that is known as actual. For budgets and calculations, you can work with as many versions as you

require. For example, you can import budget data into an original version and then revise the budget in a

revised version. For calculations, you can create multiple versions. In these various versions, you can then create

calculations by using different calculation rules that will be applied for cost allocation.
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Create fiscal calendars, fiscal years, and periods

Select fiscal calendars for ledgers, fixed assets, and budget cycles

Select a fiscal calendar for your legal entitySelect a fiscal calendar for your legal entity

Select a fiscal calendar for fixed assetsSelect a fiscal calendar for fixed assets

This article discusses fiscal calendars, fiscal years and periods and how to utilize them for legal entities, fixed

assets and budgeting.

Fiscal calendars provide a framework for the financial activity of an organization. Each fiscal calendar contains

one or more fiscal years, and each fiscal year contains multiple periods. Fiscal calendars can be based on a

January 1 to December 31 calendar year, or on any dates that you select. For example, some organizations select

a fiscal calendar that starts on July 1 of one year and ends on June 30 of the following year.

There is no limit to the number of fiscal calendars that you can create, and no limit to the number of fiscal years

that can be created for a fiscal calendar. Each fiscal calendar is independent of your organization, and can be

used by multiple legal entities in the organization. For example, an organization has eight departments and each

department is a separate legal entity. Five of them share the same fiscal calendar and three use different fiscal

calendars. You can create one fiscal calendar for the five legal entities that share the same fiscal calendar, and

then create separate fiscal calendars for the other legal entities.

You can create and delete fiscal calendars, fiscal years, and periods on the Fiscal calendars page. You can also

divide existing periods and create closing periods that can be used to close a fiscal year.

A closing period is used to separate general ledger transactions that are generated when a fiscal year is closed.

When the closing transactions are in one fiscal period, it is easier to create financial statements that either

include or exclude different types of closing entries. If a fiscal year is divided into 12 fiscal periods, the closing

period is usually the 13th period. However, a closing period can be created from any period that has a status of

Open.

When you create a closing period, select a period that has a status of Open and that has the dates that you want

to use. The new closing period will copy the starting and ending dates from the existing period. The original

period will continue to exist. For example, you select Period 12, which is the last period in the fiscal year, and that

has dates of August 1 through August 31. You enter a name for the closing period, such as Close. After you

create the new closing period, you now have the original period and the closing period. Both have dates that

start on August 1 and end on August 31.

Fiscal calendars are used with fixed asset depreciation, financial transactions, and budget cycles. When you

create a fiscal calendar, you can use it for multiple purposes. You can select a fiscal calendar for a fixed asset

book to make it a fixed asset calendar. You can select a fiscal calendar for a ledger to make it a ledger calendar.

And you can select a fiscal calendar for a budget cycle to make it a budget calendar. You can use the same fiscal

calendar for all of these.

Select the fiscal calendar that you want to use for the ledger for your legal entity in the Ledger form. A fiscal

calendar must be selected on the Ledger page for every legal entity. After a fiscal calendar is selected, you can

set up period statuses and permissions on the Ledger calendar page for any of the periods that are part of a

fiscal year.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/budgeting/fiscal-calendars-fiscal-years-periods.md
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Maintain periods for your organization
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You can select a fiscal calendar for a fixed asset book, and that fiscal calendar will be used by the fixed assets that

use the selected book. You can select from any fiscal calendar that is defined on the Fiscal calendars page.

Budget cycles are the length of time during which a budget is used. Budget cycles can include part of a fiscal

year or multiple fiscal years, such as a biennial budget cycle of two years or a triennial budget cycle of three

years. The budget cycle time span defines the number of periods that are included in the budget cycle. To specify

the budget cycle time span, use the Budget cycle time spans page.

You can use the Ledger calendar page to view the details of the fiscal calendar, fiscal years, and periods used by

your organization. You can also change the status of the periods and select which users can post accounting

transactions to periods. For example, at the start of a new period, you might want a group of users to finish

posting financial transactions in the previous period, while other groups work only in the new period.
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Custom dimensions

Entity-backed dimensions

This topic explains the various types of financial dimensions and how they are set up.

Use the Financial dimensionsFinancial dimensions  page to create financial dimensions that you can use as account segments for

charts of accounts. There are two types of financial dimensions: custom dimensions and entity-backed

dimensions. Custom dimensions are shared across legal entities, and the values are entered and maintained by

users. For entity-backed dimensions, the values are defined somewhere else in the system, such as in Customers

or Stores entities. Some entity-backed dimensions are shared across legal entities, whereas other entity-backed

dimensions are company-specific.

After you've created the financial dimensions, use the Financial dimension valuesFinancial dimension values  page to assign additional

properties to each financial dimension.

You can use financial dimensions to represent legal entities. You don't have to create the legal entities in

Dynamics 365 Finance. However, financial dimensions aren't designed to address the operational or business

requirements of legal entities. The interunit accounting functionality in Finance is designed to address only the

accounting entries that are created by each transaction.

Before you set up financial dimensions as legal entities, evaluate your business processes in the following areas

to determine whether this setup will work for your organization:

Inventory

Sales and purchases between financial dimensions and legal entities

Sales tax calculation and reporting

Operational reporting

Here are some of the limitations:

You can use sales tax functionality only with legal entities, not with financial dimensions.

Some reports don't include financial dimensions. Therefore, to report by financial dimension, you might have

to modify the reports.

To create a user-defined financial dimension, in the Use values fromUse values from field, select Custom dimensionCustom dimension.

You can also specify an account mask to limit the amount and type of information that can be entered for

dimension values. You can enter characters that remain the same for each dimension value, such as letters or a

hyphen (-). You can also enter number signs (#) and ampersands (&) as placeholders for characters that will

change every time that a dimension value is created. Use a number sign (#) as a placeholder for a number and

an ampersand (&) as a placeholder for a letter. The field for the format mask is available only when you select

Custom dimensionCustom dimension in the Use values fromUse values from field.

ExampleExample

To limit the dimension value to the letters "CC" and three numbers, enter CC-###CC-### as the format mask.

To create an entity-backed financial dimension, in the Use values fromUse values from field, select a system-defined entity to

base the financial dimension on. Financial dimension values are then created from that entity. For example, to

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/general-ledger/financial-dimensions.md


Activating dimensions

Translations

Legal entity overrides

Deleting financial dimensions

Default dimension values

create dimension values for projects, select ProjectsProjects . A dimension value is then created for each project name.

The Financial dimension valuesFinancial dimension values  page shows the values for the entity. If those values are company-specific,

the page also shows the company.

When you activate a financial dimension, the table is updated so that it includes the name of the financial

dimension. Deleted dimensions are removed. You can enter dimension values before you activate a financial

dimension. However, a financial dimension can't be consumed anywhere until it's activated. For example, you

can't add a financial dimension to an account structure until the financial dimension has been activated. When

you select ActivateActivate, all dimensions are updated and show status changes.

On the Text translationText translation page, you can enter text for the selected financial dimension in various languages. On

the Main account translationMain account translation page, you can enter text for the main account in various languages.

Not all dimensions are valid for all legal entities. Additionally, some dimensions might be relevant only for a

specific period. In these cases, you can use the Legal entity overr idesLegal entity overr ides  section to specify the companies that

the dimension should be suspended for, the owner, and the period when the dimension is active.

To help maintain referential integrity of the data, financial dimensions can rarely be deleted. If you try to delete a

financial dimension, the following criteria are evaluated:

Has the financial dimension been used on any posted or unposted transactions, or in any type of dimension

value combination?

Is the financial dimension used in any active account structure, advanced rule structure, or financial

dimension set?

Is the financial dimension part of a default financial dimension integration format?

Has the financial dimension been set up as a default dimension?

If any of the criteria are met, you can't delete the financial dimension.

You can use values from master records, such as customer and vendor, as default values in new dimensions.

When the new dimensions are created, the master record ID is entered in the dimension values for those master

records. For example, when you create a new customer, the customer ID is entered in the customer dimension.

When you create sales orders, invoices, or other documents that require a customer ID, the existing defaulting

rules are used, and the customer ID is added to the document.

This feature is controlled by a setting in the dimension. This setting is named Copy values to this dimensionCopy values to this dimension

on each new DimensionName createdon each new DimensionName created, where DimensionNameDimensionName is the name of the dimension. By default,

the feature is turned off. However, it can be turned on at any time.

If records already exist for the dimension, the master records are updated when you turn the feature on.

However, existing documents and transactions aren't updated.

If you are using a template to create a master record, make sure that the template value for the master

dimension is blank. For example, if you're creating customers from a template, make sure that the customer

dimension in the template is blank. The customer dimension value will default from the new customer number



Derived dimensions

Overriding existing values with derived dimensionsOverriding existing values with derived dimensions

Preventing changes with derived dimensionsPreventing changes with derived dimensions

when you create the new customer.

You can configure a dimension so that information for other dimensions is automatically entered when you

enter that dimension in a document. For example, if you enter cost center 10, a value of 2020  can be automatically

entered in the department dimension.

You can set up derived values on the dimensions page.

1. Select a dimension and then select Derived dimensionsDerived dimensions .

The Derived dimensionsDerived dimensions  page includes a grid. The selected dimension segment is the first column in

this grid.

2. Add the segments that should be derived. Each segment appears as a column.

Enter the dimension combinations that should be derived from the dimension in the first column. For example,

to use the cost center as the dimension that the department and location are derived from, enter cost center 10,

department 20, and location 30. Then, when you enter cost center 10 in a master record or on a transaction

page, department 20 and location 30 are entered by default.

By default, the derived dimension process doesn't override existing values for derived dimensions. For example,

if you enter cost center 10, and no other dimension is entered, department 20 and location 30 are entered by

default. However, if you change the cost center, the values that have already been established aren't changed.

Therefore, you can establish default dimensions on master records, and those dimensions won't be changed by

derived dimensions.

You can change the behavior of derived dimensions to override existing values by selecting the ReplaceReplace

existing dimension values with derived valuesexisting dimension values with derived values  check box on the Derived dimensionsDerived dimensions  page. If this field is

selected, you can enter a dimension with derived dimension values and those derived dimension values will

override any values that already exist. Using the previous example, if you enter cost center 10, and no other

dimension is entered, department 20 and location 30 are entered by default. However, if the values were already

department 50 and location 60, the values will now be changed to department 20 and location 30.

Derived dimensions with this setting do not automatically replace the existing default dimensions values when

dimension values are defaulted. Dimension values will only be overridden when you enter a new dimension

value on a page and there are existing derived values for that dimension on the page.

When you use Add segment"Add segment" on the Derived dimensions pageDerived dimensions page to add a segment as a derived dimension,

an option is provided at the bottom of the Add segmentAdd segment page that allows you to prevent changes to that

dimension when it is derived on a page. The default setting is off so it does not prevent the derived dimension

values from being changed. Change the setting to YesYes  if you want prevent the dimension from being changed

after it has been derived. For example, if the value for the Department dimension is derived from the value of

the Cost center dimension, the Department value cannot be changed if the Prevent changesPrevent changes  setting is YesYes .

The setting does not prevent changes if the dimension value is valid but it is not listed in the derived dimensions

list. For example, if Department 20 is derived from Cost center 10 and you enter Cost center 10, then you will

not be able to edit Department 20. However, if you enter Cost center 20 and it is not in the list of derived

dimensions for Cost center, then you can edit the Department value.

In all cases, the account value and all dimensions values will still be validated against the account structures after

the derived dimensions values have been applied. If you use derived dimensions and they fail validation when

used on a page, you must change the derived dimensions values on the derived dimensions page before you

can use them in transactions.



Derived dimensions and entitiesDerived dimensions and entities
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When you change dimensions on the Financials dimensionsFinancials dimensions  FastTab, the dimension that is marked to prevent

changes will not be editable. If you are entering an account and dimensions into the segmented entry control on

a page, the dimensions are editable. However, when you move the highlight off the segmented entry control and

move to another field or take an action, the account and dimensions will be validated against the derived

dimensions list and the account structures to ensure that you have entered the appropriate values.

You can set up the derived dimensions segments and values by using entities.

The Derived dimensions entity sets up the driving dimensions and the segments that are used for those

dimensions.

The Derived dimensions value entity lets you import the values that should be derived for each driving

dimension.

When you use an entity to import data, if that entity imports dimensions, the derived dimension rules are

applied during the import unless the entity specifically overrides those dimensions.

For more information, see the following topics:

Define financial dimensions

Maintain financial dimension default templates
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Chart of accounts and financial dimension components

Account structuresAccount structures

Advanced rulesAdvanced rules

Balancing dimensionBalancing dimension

Default/fixed financial dimensions on the main accountDefault/fixed financial dimensions on the main account

Order in which default dimensions are applied during posting

When you plan and set up your chart of accounts, you must consider how the various components will work

together when you post a document or journal. These components include account structures, advanced rules,

and balancing and fixed dimensions. This topic explains what each component is and how the components work

together.

A rich, rule-based system is used to define valid combinations of main accounts and financial dimension values.

This section gives a brief overview of the functionality of each component and explains where you can find the

component.

An account structure is required when you set up your ledger. You must define and activate at least one account

structure, and you must assign it to the ledger. The account structure must have the main account in it. You can

define the order of segments that works best for the business. After the main account is defined, the system can

determine the account structure that is used. By putting the main account first or near the front of a structure,

you can help limit the values and also help the system apply the last known valid value as a default value. You

can have up to 10 additional financial dimensions in the account structure. The account structure defines which

dimension values are valid in combination with other values. It also defines whether dimension values must be

entered.

Advanced rules are an optional component when you set up the chart of accounts. You can add as many

advanced rules as you want to an account structure. Advanced rules are often used to handle scenarios where

additional financial dimensions must be tracked when specific criteria are met. For example, if you use a Travel

expense account, you might want to track additional information, such as the event that the employee is

traveling for. If there are multiple advanced rules, they are applied in alphabetical order, based on the names of

the rules. The segments that a rule adds can be applied only after the segments of the account structure.

You can optionally define a balancing financial dimension. On the LedgerLedger  page, you can define the financial

dimension that should be balanced. Then, whenever transactions are posted to that financial dimension, the

system automatically creates and posts entries to make the financial dimension balanced.

Default dimensions come from various places, such as master records (for example, customer or vendor

records), document headers, and the main account. This topic focuses on default dimensions on the main

account by legal entity. You can define whether a main account has a Not fixedNot fixed or FixedFixed value for each financial

dimension that is used across all account structures for the ledger. If a financial dimension is Not fixedNot fixed, it uses a

default value, but that value can be overwritten. This behavior applies to all default values in the system, even

default values that come from master records. If a financial dimension is set to a FixedFixed value, that value is

always applied, regardless of whether it came from somewhere as a default value or the user entered it.

People often have questions about the order that the various components run in. It's very important that you

understand the order that default dimensions are applied in, because this behavior affects the approach that you

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/general-ledger/Default-dimensions.md
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Example 1Example 1

M A IN  A C C O UN TM A IN  A C C O UN T B USIN ESS UN ITB USIN ESS UN IT DEPA RT M EN TDEPA RT M EN T C O ST  C EN T ERC O ST  C EN T ER

All values are allowed. All values are allowed. All values are allowed. All values are allowed.

M A IN  A C C O UN TM A IN  A C C O UN T N A M EN A M E L EGA L  EN T IT YL EGA L  EN T IT Y DEPA RT M EN TDEPA RT M EN T

401100 Product Sales USMF Fixed – 022 Sales and
Marketing department

take to setup.

This information applies only to the application of default dimensions in the application. If you import data by using

Microsoft Excel or the Data Management Framework, the behavior differs.

Account structureAccount structure

Main accountMain account

The following illustration shows the fixed default dimension that is set on main account 401100.

For this very basic example, we will enter a general journal where the Department dimension is set to use the

default value 023023  (Operations). We will enter and post a ledger account. The following illustration shows the

default financial dimension on the general ledger header.

file:///T:/eiye/ac1a/dynamics365/finance/general-ledger/media/default-dimensions.png
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The default dimension on the journal header will cause department 023 to be applied by default on the sales

account line. The following illustration shows the general journal line, where the 023023  default dimension value

from the header is applied.

However, when the line is posted, the fixed dimension is applied, and the line is posted to department 022. The

following illustration shows the posted voucher, where the fixed dimension is applied for the sales account.

This example uses the same setup as the first example. However, we will add a second component and use the

Department dimension as a balancing dimension. In the following illustration, Depar tmentDepar tment is set as the

balancing financial dimension for the USMF ledger.

file:///T:/eiye/ac1a/dynamics365/finance/general-ledger/media/general-journal.png
file:///T:/eiye/ac1a/dynamics365/finance/general-ledger/media/journal-voucher.png
file:///T:/eiye/ac1a/dynamics365/finance/general-ledger/media/voucher-transactions.png
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When the same journal header setup is used, and the same transaction is posted, the fixed dimension is applied

first. Then the balancing logic is applied to help guarantee that every department has a balanced entry. The

following illustration shows voucher transactions that include the balancing entry after the fixed dimension is

applied.

In this example, we will add an advanced rule. The advanced rule specifies that if sales account 401100 and

department 022 (Sales and Marketing) are used, the system should track an additional segment that is named

Customer.

This example is important because of the order. The account structure is determined after the main account is

entered. If you refer to the account structure setup, the system can determine that the main account, business

unit, department, and cost center are relevant. At this point, the advanced rule hasn't been triggered, because

fixed dimensions aren't applied until default dimensions have been applied for the journal voucher during

posting. In the following illustration, the Customer segment isn't present, because the criteria for the advanced

rule haven't been met.

The posting won't be successful, because the fixed dimension was applied at the end of the process. Dimension

validation determines that the Customer segment is required if the main account is 401100 and the department

is 022. Posting can't occur because of the validation error. The following illustration shows the message that

file:///T:/eiye/ac1a/dynamics365/finance/general-ledger/media/ledger.png
file:///T:/eiye/ac1a/dynamics365/finance/general-ledger/media/voucher-transactions2.png
file:///T:/eiye/ac1a/dynamics365/finance/general-ledger/media/drop-down.png
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appears after dimension validation determines that Customer is a required segment.

In this example, you must overwrite the default value so that the advanced rule is triggered and you can enter

the Customer segment. However, this solution isn't always possible, and some users aren't even aware of the

posting rules. Therefore, it's important that you understand the order that default dimensions are applied in

when you set up your chart of accounts.

To achieve what you want in this example, you can change the configuration in several ways. For example, you

can create a new account structure for sales accounts and include the Customer segment in the structure. You

can also add more rows in an existing account structure, and specify the main account and valid department

values. Then, in the additional customer structure, you might find it useful to have a separate account structure

of sales accounts where the Customer segment is present.

Some of the following resources refer to an earlier version of our software. However, much of the information

about the application of default dimensions and many of the concepts are the same in the earlier version, and

the references are still valid.

Balanced journals for interunit accounting

Plan your chart of accounts

Planning your chart of accounts in AX 2012 blog – This link goes to part 1 of a seven-part series.

Dimension defaulting in accounting distributions

Dimension defaulting in Dimensions framework
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This topic explains how to add financial dimensions to the Chief Financial Officer (CFO) workspace, so that they

can be used for the ledger and budget reports. The CFO workspace has an Over viewOver view  tab and a FinancialFinancial  tab.

The reports on these two tabs are backed by two measures: LedgerActivityMeasure and BudgetActivityMeasure.

There is a relation between those two measures and the DimensionCombinationEntity entity. Therefore, you can

select dimensions.

TIPTIP

1. In Finance, on the Entity StoreEntity Store page, update the LedgerActivityMeasureLedgerActivityMeasure and the

BudgetActivityMeasureBudgetActivityMeasure measures.

2. In Microsoft Visual Studio, open Application Explorer, and search for LedgerCFOLedgerCFO.

3. Under ResourcesResources , open LedgerCFOWorkspacePBIXLedgerCFOWorkspacePBIX.

4. When the resource opens in Microsoft Power BI desktop, select Get DataGet Data, select SQL Ser ver databaseSQL Ser ver database,

and then select ConnectConnect.

5. Enter the server name, and enter AxDWAxDW as the database. Select DirectQuer yDirectQuer y , and then select OKOK.

6. Search for and select LedgerActivityMeasure_DimensionCombinationLedgerActivityMeasure_DimensionCombination, and then select LoadLoad.

In the FieldsFields list, rename the table Financial dimensionsFinancial dimensions , so that it's easy to identify.

7. Select Manage RelationshipsManage Relationships , and then select NewNew .

8. In the first field, select General Ledger ActivitiesGeneral Ledger Activities , and then select LedgerDimensionLedgerDimension.

9. In the second field, select LedgerActivityMeasure_DimensionCombinationLedgerActivityMeasure_DimensionCombination (or FinancialFinancial

dimensionsdimensions  if you renamed the table). Select the DimensionCombinationRECIDDimensionCombinationRECID header.

10. In the CardinalityCardinality  field, select Many to OneMany to One.

11. Change the Cross filter  directionCross filter  direction value to S ingleSingle.

12. Select both Make this relationship activeMake this relationship active and Assume referential integrityAssume referential integrity , select OKOK, and then

select CloseClose.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/general-ledger/CFO-workspace.md
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13. In the FieldsFields  list, you should see the table and the available financial dimensions. Drag the financial

dimensions that you want to the report-level filters.

14. Save your changes.

15. In the Application Object Tree (AOT), right-click your project, and then select SynchronizeSynchronize.

16. Build your project, and then open the application to view the results.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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NOTENOTE

This task guide steps through creating an account structure. The steps use demo data company USMF.

1. Go to Navigation pane > Modules > General ledger > Char t of accounts > Structures >Navigation pane > Modules > General ledger > Char t of accounts > Structures >

Configure account structuresConfigure account structures .

2. On the Action paneAction pane, click NewNew  to open the drop dialog.

3. In the Account structureAccount structure field, type a name to describe the purpose of the account structure.

4. In the Descr iptionDescr iption field, type a description to specify the purpose of the account structure.

5. Click CreateCreate.

6. In the Segments and allowed valuesSegments and allowed values , click Add segmentAdd segment.

7. In the dimensions list, select the dimension to add to the account structure.

8. At the end of the list, click Add segmentAdd segment.

9. Repeat step 6 to 9 as needed.

10. In the Allowed value detailsAllowed value details  section, select the segment to edit the allowed values. For example, click the

Main AccountMain Account field.

11. In the OperatorOperator  field, select an option, such as is between and includes.

12. In the ValueValue field, type a value. For example, 600000.

13. In the throughthrough field, type a value. For example, 699999.

14. In the Allowed value detailsAllowed value details  section, click ApplyApply .

15. Repeat step 10 to 15 as needed.

16. In the Allowed value detailsAllowed value details  section, click Add new cr iter iaAdd new cr iter ia .

17. In the Operator field, select an option, such as is between and includes.

18. In the ValueValue field, type a value. For example, 033.

19. In the throughthrough field, type a value. For example, 034.

20. Click ApplyApply .

21. In the grid, select the segment to edit the allowed values. For example, Cost Center.

22. In the CostCenter fieldCostCenter field, type a value. For example, 007..021.

23. In the Segments and allowed valuesSegments and allowed values , click AddAdd.

24. In the MainAccountMainAccount field, type a value. For example, 600000..699999

25. In the grid, select the segment to edit the allowed values. For example, Department.

26. In the Department field, type a value. For example, 032.

27. In the CostCenter field, type a value. For example, 086.

28. On the Action paneAction pane, click ValidateValidate.

29. On the Action paneAction pane, click ActivateActivate.

30. Click ActivateActivate.

Can you tell us about your documentation language preferences? Take a short survey.
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Overview

Configuration

Almost every company that uses Financials functionality in Microsoft Dynamics 365 Finance will have to be able

to create reports of budget vs. actuals. This article explains the minimum configuration that is required in order

to create budgets in Finance and Operations or load them from a third-party program.

The approved budget for a legal entity is maintained in a document that is known as a budget register entry. The

lines in a budget register entry document are known as budget account entries, and contain financial dimension

information, dates, and the amounts of the approved budget. The budget register entry document is integrated

with basic financial reports and inquiry pages where ledger actual amounts are compared to budget amounts.

There are multiple methods for creating budget register entries:

Manually enter the document information on the Budget register entr iesBudget register entr ies  page.

Use the Microsoft Excel template that you can open by clicking the Open in ExcelOpen in Excel  button on the BudgetBudget

register entr iesregister entr ies  page.

Use the Budget Account Entr iesBudget Account Entr ies  data entity in Data management to import budget register entries. You

should consider using this method and turning on the Set basedSet based **processing **parameter when you must

import many budget account entries into the system.

If the company uses Budget planning functionality to prepare budget data, you can use the GenerateGenerate

budget register entr ybudget register entr y  periodic process.

The budget register entry is considered completed when the budget balances have been updated. On the

Budget register entr iesBudget register entr ies  page, click Update budget balancesUpdate budget balances  for a selected budget register entry or multiple

entries. After you update the budget balances, the status of the budget register entry changes to CompletedCompleted.

Completed budget register entry can't be re-opened for edits. Therefore, if the budget data must be adjusted,

you must create a new budget register entry instead of correcting data in the completed budget register entry.

When you configure budgeting, start on the Budgeting parametersBudgeting parameters  page. On this page, you must define the

budget journal, the number sequence for budget register entries, and the default behavior in the workspaces.

Next, if there are policies that govern the approval of budget register entries, based on budget type (for example,

transfers or revisions), you must create budget register entry workflows on the Budgeting workflowsBudgeting workflows  page. If

there are scenarios where transfers might be allowed without workflow approval, you can define budget

transfer rules to support those scenarios.

On the Budgeting dimensionsBudgeting dimensions  page, you must select the financial dimensions that are used for budgeting,

based on the dimensions that are used in the chart of accounts. You can select all financial dimensions or a

subset of them for budgeting.

Define a *budget model *that corresponds to all or some of the budgets. You can use a single budget model for

all budget register entries. Alternatively, you can create separate models that are based on the budget type, the

geographical location, or some other way that a budget can be classified.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/budgeting/basic-budgeting-overview-configuration.md
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Using workspaces and inquiry pages to track budget vs. actuals

If budget control is used, you can associate only one budget model with a specific budget cycle time span.

Create budget codes that identify the type of budget transactions to record and any related workflow. Budget

codes can support the following budget types:

Original budget

Transfer

Revision

Encumbrance

Pre-encumbrance

Carry-forward budget

Budget codes let you have an audit trail of approved budget modifications throughout the course of the budget

cycle. If a workflow is associated with a budget code, the workflow will be enabled for all budget register entries

that use that budget code, and workflow steps must be completed before the budget register entry can reach

the CompletedCompleted stage.

You can also optionally set up budget transfer rules. To use budget transfer rules, select Use rules for budgetUse rules for budget

transferstransfers  on the Budget parametersBudget parameters  page. When budget transfer rules are used, if a user creates a document

by using a budget code of the TransferTransfer  type, budget balances won't be updated if the budget transfer rules are

violated. For example, you can allow budget transfer documents where the expense budget is transferred

between the main accounts for the Sales and Marketing department, but can prohibit budget from being

transferred from or to that department unless workflow approval has been granted for that type of budget

account entry.

Functionality that was introduced in Microsoft Dynamics 365 Finance version 10.0.7 (January 2020) added

capability and flexibility for budget register entries. To enable these enhancements, go to the FeatureFeature

managementmanagement workspace and select Budget register entr ies for quantity onlyBudget register entr ies for quantity only  and/or Budget registerBudget register

entr ies defaulting of amount typeentr ies defaulting of amount type.

The Budget register entr ies for quantityBudget register entr ies for quantity  only feature lets you post a budget register entry with quantity-

only amounts. For example, you could post a budget entry with a quantity of 32 and a price of zero, which

results in an amount of zero. You can then use this quantity within the context of a financial report to determine

a price per quantity. Note that no inquiries or reports were updated as part of this feature; the feature just

enables you to post an amount of zero.

The Budget register entr ies defaulting of amount typeBudget register entr ies defaulting of amount type feature allows the default amount type within a

budget register entry to be an amount type other than expense. The budget register entry line now will default

to expense when the main account type is expense; will default to revenue when the main account type is

expense; and will default to expense for all other account types.

The budget manager can review the current state of a budget in the Ledger budgets and forecastsLedger budgets and forecasts

workspace. The Expense over budgetExpense over budget and Revenue under budgetRevenue under budget tabs provide a quick view of the financial

dimension combinations where budget targets aren't being met or are approaching the threshold. You can

personalize the budget threshold percentage and financial dimension sets that are used on those tabs by

clicking Configure my workspaceConfigure my workspace. You can click Unit managersUnit managers  to see the workers who are responsible for

specific financial dimension combinations that are selected on those tabs. For example, if you see that the

expense budget of the Operations department is going over the budget threshold, you can easily find and

contact the Operations department manager to discuss the issue.
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NOTENOTE

The Depar tment managerDepar tment manager  field on the Organization UnitsOrganization Units  page determines which managers support specific

financial dimension combinations. Click See moreSee more at the bottom of the tab to open the Budget vs actualsBudget vs actuals  inquiry page

for more details about budget amounts versus actual amounts.

The Actual vs budgetActual vs budget inquiry page lets you drill into the details of the budget versus actual amounts. Select a

line on the inquiry page, and then click Per iod balancesPeriod balances  to see budget and actual amounts spread across fiscal

periods. The Budget account entr iesBudget account entr ies  page provides drill-through to the details of the budget amount in

budget register entries. The General journal entr iesGeneral journal entr ies  page opens the ledger transactions that are included in

the calculated ActualsActuals  amount.

A company that is using Budget planning functionality can create and use budget forecasts in the LedgerLedger

budgets and forecastsbudgets and forecasts  workspace.
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NOTENOTE

Cost accounting is an independent module that requires data from other modules. This data is categorized into

the following:

Cost elements

Cost objects

Statistical dimensions

A Cost elementCost element corresponds to a cost-relevant item in the chart of accounts. A Cost objectCost object corresponds to

any type of financial dimension, such as products, cost centers, and projects that you want to estimate, allocate

costs to, or measure directly. A Statistical dimensionStatistical dimension and its members are used to register non-monetary

entries. Statistical dimension members can be used as an allocation base in cost distribution and allocation

The following diagram illustrates the dimensions that are used in Cost accounting.

After the data is imported into Cost accounting, you can use it to build various perspectives that provide insights

to managers at all levels of the organization. The following topics provide information about creating

dimensions and importing dimension members.

Cost element dimensions

Create cost elements

Cost object dimensions

Map cost element dimension members to a common set of dimension members

Map a cost element dimension

Statistical dimension members and statistical measure provider templates
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Two types of cost elements

Primar y cost elementsPrimar y cost elements Secondar y cost elementsSecondar y cost elements

The primary cost elements represent the flow of costs from
financial accounting to cost accounting. The cost element
structure corresponds to the profit and loss account
structure in the general ledger, where a cost element can
correspond to a main account. Not all main accounts may
necessarily be represented as cost elements depending on
the business needs. Examples of primary cost elements
include:

The secondary cost elements represent the flow of costs
internally because these costs are created and used only in
Cost accounting. They are used to secure that the source of
costs can be traced. These cost elements are used in cost
allocations and overhead calculations. Examples of secondary
cost elements include:

Cost element dimensions and cost element dimension members

As one of the core pillars in Cost accounting, cost element dimensions are used to categorize and track where

costs flow to.

A cost element corresponds to a cost-relevant item in the chart of accounts. Basically, it can be any type of

element at the lowest level in a business where costs can flow to. Cost elements as a concept range from ledger

accounts to all cost-relevant resources. Currently, Cost accounting supports ledger accounts.

There are two types of cost elements: primary cost elements and secondary cost elements. The following table

describes the difference between the two types.

Costs of goods sold (COGs)

Indirect material costs

Personnel costs

Energy costs

Production costs

Production, material, and marketing overheads

Cost elements are referred to as cost element dimensions . The individual dimension values are called cost

element dimension members. For example, you have a US chart of accounts structure (COA) that is the base for

your statutory reporting. This COA is used as the cost element dimension. The accounts, which are primary cost

elements, are represented as the cost element dimension members in Cost accounting. The following screenshot

shows an example of Main Accounts as the cost element dimension with its actual main accounts as the cost

element dimension members.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/cost-elements.md


Import cost element dimension members through data connectors

Implementation considerations

NOTENOTE

To ease the setup of cost element dimension members in Cost accounting, you can use data connectors that are

either pre-built or your custom build to retrieve the primary cost elements from one or more source systems.

As cost elements represent the lowest level of cost details, you should make sure that all the cost elements

required to make the managerial reporting are included when you implement the cost elements structure. It can

be a challenge to find an appropriate number of cost elements for cost control. Having thousands of cost

elements can make it difficult to control each cost element. As an alternative, you can group cost elements and

manage cost control at an aggregated level.
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Create new cost elements

Configure the data connector

Import main accounts

View the imported accounts as cost elements

NOTENOTE

There are several ways to create cost elements in Cost accounting. This procedure shows how to create cost

elements by importing main accounts via a data connector. The USMF demo company was used to create this

procedure. This procedure is for a Cost accounting feature that was added in Dynamics 365 for Operations,

version 1611.

1. Go to Cost accounting > Dimensions > Cost element dimensions.

2. Click New.

3. In the Name field, type a value.

4. In the Data connector for dimension members field, enter or select a value.

5. In the Description field, type a value.

6. Click Save.

1. Click Configure dimension member provider.

2. In the Chart of accounts field, enter or select a value.

3. Click New.

4. In the list, mark the selected row.

5. In the From main account field, enter or select a value.

6. In the To main account field, enter or select a value.

7. Click OK.

Select Shared to use the shared chart of accounts.

You can apply filters to accounts to meet your criteria.

1. Click Import dimension members.

2. Click OK.

Main accounts will be imported into Cost accounting and used as cost elements.

1. Click View dimension members.

View the imported ledger accounts as cost elements in your business that costs can flow to.
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Cost object dimensions and cost object dimension members

Import cost object dimension members through data connectors

When you analyze costs, you use cost element dimensions to determine where costs flow to. You use cost object

dimensions to determine where you should assign costs. This topic provides information about cost object

dimensions.

A cost object can be any type of object that you want to estimate, allocate costs to, or measure directly. Typical

cost objects include products, projects, resources, departments, cost centers, and geographical regions.

Management uses cost objects to quantify costs and also to drive profitability analysis.

Cost objects are known as cost object dimensions. After you’ve decided which entity the cost object dimension

should refer to, you must specify the individual dimension values or import them into Cost accounting from

other source systems. These individual dimension values are known as cost object dimension members. For

example, you want to use the financial dimension that is named Cost center as the cost object dimension. To see

how costs flow to the individual cost centers, you must import the cost object dimension members. In this case,

the cost object dimension members are the actual cost centers, such as Sales, Production, Administration, and

Geographic locations. The following screenshot shows an example of Cost Centers as the cost object dimension

with its actual cost centers as cost object dimension members.

To make the import of cost object dimension members easier, you use data connectors to retrieve the values

from the entities that you want to use as cost object dimensions. You can use either the pre-built data

connectors or custom data connectors that you build.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/cost-objects.md
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Create new cost objects

Configure the data connector

Import cost centers

View the imported cost centers

NOTENOTE

This procedure shows how to create cost objects by importing the cost center financial dimension into Cost

accounting via a data connector. The USMF demo company was used to create this procedure.

1. Go to Cost accounting > Dimensions > Cost object dimensions.

2. Click New.

3. In the Name field, type a value.

4. In the Data connector for dimension members field, enter or select a value.

5. In the Description field, type a value.

6. Click Save.

1. Click Configure dimension member provider.

2. In the Dimension name field, select Cost center.

3. Click OK.

Select CostCenter to import the CostCenter dimension into Cost accounting.

1. Click Import dimension members.

2. Click OK.

1. Click View dimension members.
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Map cost element dimension members to a common format

SO URC E :  US C H A RT  O F  A C C O UN T SSO URC E :  US C H A RT  O F  A C C O UN T S
SO URC E :  F REN C H  C H A RT  O FSO URC E :  F REN C H  C H A RT  O F
A C C O UN T SA C C O UN T S

N EW  C O M M O N  SET  O F  C O STN EW  C O M M O N  SET  O F  C O ST
EL EM EN T  DIM EN SIO N  M EM B ERSEL EM EN T  DIM EN SIO N  M EM B ERS

Imported cost element dimension
members from the US chart of
accounts

Imported cost element dimension
members from the French chart of
accounts

Mapping of US and French cost
element dimension members to a
common set

5001: Sales 5001: Sales and advertising 5000: Sales and advertising

5030: Advertising 6390: Stock purchase* 7000: Cleaning expenses

7001: Cleaning expenses 7001: Travel expense 7001: Travel expenses

Currency conversion

Update mappings at any time

By mapping different cost element dimension members to a common set of cost element dimension members,

you merge data into a common format for analysis purposes.

If you're a global company and comply with statutory accounting requirements, you might use multiple charts

of accounts. When you import cost element dimension members from different charts of accounts, you can end

up with a mix of accounts. However, these accounts might actually have the same nature, and you might want to

analyze and allocate costs for them by using a common format.

The following example shows how you, as a cost controller, can create a new cost element dimension in Cost

accounting that maps cost element dimension members from the US chart of accounts structure and the French

chart of accounts structure to a common set of cost element dimension members. You can then use the

common set of cost element dimension members to analyze cost data from the two legal entities in a cost

accounting ledger.

*The Stock purchase French cost element dimension member isn't mapped.

The various charts of accounts that you use might be set up to use different currencies. In this case, be sure to

specify a currency conversion, so that cost data is processed by using the correct currency, as defined in the cost

accounting ledger where the cost element dimension members are used. In the preceding example, if US dollars

(USD) are used in the cost accounting ledger, you must create a currency conversion from USD to euros (EUR) to

process transactions for the mapped cost element dimension members.

You can update the mapping definitions for a cost element dimension at any time. Because mappings aren't

date-effective, changes are applied the next time that you process cost transactions or run cost calculations.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/map-cost-elements-dimension-members.md
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NOTENOTE

A cost controller can use this procedure to map a cost element dimension to a cost element dimension in the

MXMF legal entity. This recording uses the USP2 demo data company.

1. Go to Cost accounting > Dimensions > Cost element dimensions.

2. In the list, find and select the desired record.

3. Click Dimension mappings.

4. Click Configure mappings from this dimension.

5. Click New.

6. In the To dimension field, enter or select a value.

7. Click New.

8. In the list, mark the selected row.

9. In the From dimension member field, enter or select a value.

10. In the To dimension member field, enter or select a value.

11. Click Save.

For this example, select Cost elements.

For this example, select MXMF Cost elements.

For this example, select dimension member 606400 Telephone & Fax Expense.

For this example, select dimension member 6001004 Telefono.
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Overview

This topic provides information about dimension hierarchies. You use a dimension hierarchy to define the

reporting structure, cost policies, and security setup in Cost accounting.

Dimension hierarchies are used in various places in Cost accounting. A dimension hierarchy lets you define the

following information:

The reporting structure that fits into the organization's requirements

Cost policies

The security setup

Here is an example of a dimension hierarchy.

A dimension hierarchy can be created for the following types of dimensions:

Cost element dimensions

Cost object dimensions

Statistical dimensions

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/dimension-hierarchy.md
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Dimension hierarchy type

Dimension categorization hierarchyDimension categorization hierarchy

Dimension classification hierarchyDimension classification hierarchy

Create and maintain a dimension hierarchy

ExampleExample

You can create multiple dimension hierarchies for the same dimension if different perspectives are required.

A dimension hierarchy can be associated with only one dimension.

A dimension hierarchy can have unlimited levels in its structure. All the levels will be available in the Cost controlCost control

workspace. When you use Microsoft Excel or Microsoft Power BI for reporting purposes, only the first 15 levels of the

dimension hierarchy are exported. This limitation exists because both Excel and Power BI require a fixed schema.

A dimension hierarchy isn't date-effective. Therefore, any change to a dimension hierarchy is immediately saved to the

record, and you can't compare the before date and after date.

When you create a new dimension hierarchy, you must select a hierarchy type. Go to Cost accountingCost accounting >

DimensionsDimensions  > Dimension hierarchiesDimension hierarchies . Click NewNew , and select a dimension hierarchy type. You can select

either Dimension categorization hierarchyDimension categorization hierarchy  or Dimension classification hierarchyDimension classification hierarchy .

The Dimension categorization hierarchyDimension categorization hierarchy  type is used for reporting purposes. It supports only the cost

element dimensions. When you select this type, the following rules apply:

A dimension member can be associated more than one time in the hierarchy structure.

You can put a cost element dimension member in different nodes by assigning a cost behavior to the leaf

node.

The Dimension classification hierarchyDimension classification hierarchy  type is used to define rules and for reporting purposes. It supports

all dimensions, such as cost objects, cost elements, and statistical dimensions. When you select this type, a

dimension member can be associated only one time in the hierarchy structure.

A dimension hierarchy is created as a tree structure that has node and leaf node relationships.

A node can have 1:n subnodes.

A node can’t have both subnodes and leaf nodes assigned to it.

A leaf node can be assigned only at the lowest level in the hierarchy.

A small company has the following organization structure, where Finance and Human resources are

departments under Admin, and Assembly and Packaging are departments under Production.

A cost object dimension represents all the cost centers in the organization.



C O ST  C EN T ERSC O ST  C EN T ERS DESC RIP T IO NDESC RIP T IO N

CC001 HR

CC002 Finance

CC003 Tax

CC007 AR/AP

CC005 Assembly

CC006 Packaging

C O ST  EL EM EN T SC O ST  EL EM EN T S DESC RIP T IO NDESC RIP T IO N

10001 Electricity

10010 Cleaning

10011 Heating

40001 COGS

DIM EN SIO N  H IERA RC H YDIM EN SIO N  H IERA RC H Y
N A M EN A M E DIM EN SIO NDIM EN SIO N

DIM EN SIO N  H IERA RC H YDIM EN SIO N  H IERA RC H Y
T Y P E N A M ET Y P E N A M E A C C ESS L IST  H IERA RC H YA C C ESS L IST  H IERA RC H Y

Organization Cost centers Dimension classification
hierarchy

No

DIM EN SIO N  M EM B ER RA N GESDIM EN SIO N  M EM B ER RA N GES

NodesNodes From dimension memberFrom dimension member To dimension memberTo dimension member

Organization

  Admin

Cost object dimension

Cost centers

The cost object dimension that represents all the cost centers can be set up as shown here.

A cost element dimension represents all the cost elements in the organization.

Cost element dimension

Cost elements

The cost element dimension that represents all the cost elements can be set up as shown here.

A dimension hierarchy that meets the organizational reporting requirements can be set up as shown here.

Dimension hierarchy detailsDimension hierarchy details

The dimension hierarchy for reporting can be set up as shown here.



    Finance CC002 CC003

CC007 CC007

    HR CC001 CC001

  Production

    Packaging CC005 CC005

    Assembly CC006 CC006
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Cost behavior Cost elements Dimension classification hierarchy
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NodesNodes From dimension memberFrom dimension member To dimension memberTo dimension member

Cost behavior

  Fixed cost 10001 10011

  Variable cost 40001 40010

NOTENOTE

Copy a hierarchyCopy a hierarchy

Rearrange nodes in a hierarchyRearrange nodes in a hierarchy

A dimension hierarchy that meets the policy requirement can be set up as shown here.

Dimension hierarchy detailsDimension hierarchy details

The dimension hierarchy for the policy can be set up as shown here.

Under Dimension member rangesDimension member ranges , a node can contain 1:n dimension member ranges. You can insert dimension

member IDs that don’t yet exist as dimension members. This approach makes the hierarchy resilient for the future.

You can copy a current dimension hierarchy as the starting point for a new dimension hierarchy. This approach

can be useful if you want to compare the previous dimension hierarchy to the new dimension hierarchy.

You can move a node up and down within its current level in the structure. In this way, you can rearrange the

order of nodes for reporting in the Cost controlCost control  workspace.

You move a node to a new location in the hierarchy by selecting the target node. There are two ways to move a

node:

Move belowMove below  – Move the selected node from its current position in the hierarchy, and insert it underunder  the

selected target node.

Move afterMove after  – Move the selected node from its current position in the hierarchy, and insert it afterafter  the



NOTENOTE

Define dimension hierarchies for reporting
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Organization Admin Finance CC002

Organization Admin Finance CC003

Organization Admin Finance CC007

Organization Admin HR CC001

Organization Production Packaging CC005

selected target node at its level of the hierarchy.

The order of the nodes isn't maintained when you export data to Excel or Power BI, because those tools use an

alphanumeric sort order by default. You should manually rearrange the order.

Dimension hierarchies are important for reporting. They let you define the specific structure that fits into the

individual organization. The aggregations that are done at the node level of the dimension hierarchy let

stakeholders at any level of the organization see data at any level.

Dimension hierarchies are available in the following reporting tools. This approach helps guarantee consistency

in the reporting structure.

Cost controlCost control  workspace (Client):

Controlled by configuration.

Cost controlCost control  workspace (Mobile application):

Controlled by configuration.

Excel

Provides the option to select specific dimension hierarchies per export definition:

One cost element dimension hierarchy (mandatory)

One cost object dimension hierarchy (optional)

One statistical dimension hierarchy (optional)

Power BI:

All dimension hierarchies are available.

If you create reports by using Excel or Power BI, only the first 15 levels of the dimension hierarchies are

exported. This limitation exists because a fixed schema is required in Excel and Power BI. If a hierarchy has more

than 15 levels, the additional levels won't be exported. The normalized table contains a record for each

dimension member in the hierarchy. Therefore, automated aggregation occurs. This behavior helps guarantee

that the balances at any of the 15 available levels in the hierarchy are still correct.

The following example shows what a dimension hierarchy might look like in the reporting structure.
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Update the dimension hierarchies that are used for reportingUpdate the dimension hierarchies that are used for reporting
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Define dimension hierarchies for cost policies

Example: Define a cost behavior policyExample: Define a cost behavior policy

P O L IC Y  N A M EP O L IC Y  N A M E
C O ST  EL EM EN TC O ST  EL EM EN T
DIM EN SIO N  H IERA RC H YDIM EN SIO N  H IERA RC H Y

C O ST  O B JEC T  DIM EN SIO NC O ST  O B JEC T  DIM EN SIO N
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Cost behavior Cost behavior Organization USD

Over time, the dimension hierarchies that are used in the previously mentioned reporting tools will have to be

updated. You can update dimension hierarchies by refreshing the client.

Cost controlCost control  workspace (Client)

Cost controlCost control  workspace (Mobile application)

Updates to dimension hierarchies are picked up every 24 hours by a pre-cached job. After the exported data is

updated, the updated dimension hierarchies are available in the following tools:

Excel

Power BI

To manually trigger an update of the dimension hierarchy cache, you can create a new export to Excel for the dimension

hierarchy or hierarchies that must be updated.

Cost accounting consists of multiple policies where detailed rules are defined. You must define one or more

dimension hierarchies for the following policies:

Cost behavior

Cost distribution

Cost allocation

Cost rollup

Dimension hierarchies make it easy to create rules. To avoid having to create rules for every dimension member,

you can take advantage of the aggregations of dimension members that are provided by dimension hierarchy

levels. If you have overlapping rules, you must define specific rules that the system will consider when it does

the overhead calculation.

A new cost behavior policy is created, and appropriate dimension hierarchies are assigned to the policy, as

shown here.

Cost behavior policyCost behavior policy

RulesRules
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F IXEDF IXED
P ERC EN TA GEP ERC EN TA GE F IXED A M O UN TF IXED A M O UN T VA L ID F RO MVA L ID F RO M VA L ID TOVA L ID TO

Fixed cost Organization 100.00 0.00 1/1/2017 Never

10001 Organization 0.00 150.00 1/1/2017 Never

10001 (*) Finance 50.00 1/1/2017 Never

Cost behavior or
Variable cost (**)

Organization 0.00 0.00 1/1/2017 Never

C O ST  EL EM EN TC O ST  EL EM EN T
DIM EN SIO NDIM EN SIO N
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N O DEN O DE

C O ST  O B JEC TC O ST  O B JEC T
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N O DEN O DE

F IXEDF IXED
P ERC EN TA GEP ERC EN TA GE F IXED A M O UN TF IXED A M O UN T VA L ID F RO MVA L ID F RO M VA L ID TOVA L ID TO

Fixed cost Organization 100,00 0,00 1/1/2017 Never

10001 Organization 0,00 150,00 1/1/2017 Never

10001 Finance 50,00 1/1/2017 20/1/2017

Cost behavior or
Variable cost

Organization 0,00 0,00 1/1/2017 Never
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Define dimension hierarchies for security setup

* The variable cost node isn't required. If a cost isn't classified as a fixed cost, it must be a variable cost.

** A detailed rule is created for the combination of cost element member 10001 and all cost object members

that are aggregated under the Finance hierarchy level (CC002, CC003, CC007).

The preceding rules show the flexibility that dimension hierarchies provide. By defining high-level rules, you can

help minimize maintenance. You can then define detailed rules to fit into a specific business objective.

If the dimension hierarchies that are used in rules are updated, the system automatically brings the updates

forward.

If a level of granularity in the rules is no longer required, the rule can be expired.

For example, a specific cost behavior rule for the Finance cost object dimension hierarchy node is no longer

required. In this case, click Expire ruleExpire rule to expire the rule.

Any overhead calculation that is run after January 20, 2017, no longer considers this rule.

The Valid fromValid from and Valid toValid to fields are date-effective and time-effective. You can expire the rule and run a new overhead

calculation on the same day.

Cost accounting data should be made available to all managers who are responsible for a reporting unit. In Cost

accounting terminology, a reporting unit is represented as a cost object or a set of cost objects.

Potentially, all managers will be able to access highly sensitive business data, such revenues and margins.
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Organization Cost centers Dimension classification
hierarchy

YesYes

USERSUSERS
DIM EN SIO N  M EM B ERDIM EN SIO N  M EM B ER
RA N GESRA N GES

NodesNodes User IDUser ID From dimensionFrom dimension
membermember

To dimension memberTo dimension member

Organization Benjamin, Claire

  Admin April

    Finance Alicia CC002 CC003

CC007 CC007

    HR Arnie CC001 CC001

  Production David

    Packaging Ellen CC005 CC005

    Assembly Chris CC006 CC006
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Therefore, it's important that you set up security, so that managers see only the data that is relevant to them. To

help control data security, you define dimension hierarchies.

The use of dimension hierarchies applies only when the dimension value that is selected in the dimension

hierarchy reference is a cost object dimension.

Only one dimension hierarchy can be enabled per cost object dimension in the access list hierarchy.

Dimension hierarchy detailsDimension hierarchy details

A new UsersUsers  FastTab is available in the hierarchy designer. Here, you can insert one or more user IDs at each

node in the hierarchy.

Cost accountants should be assigned to the top level of the hierarchy, so that they can see all entries in Cost accounting.

To enable the access list hierarchy and its security settings, go to Cost accountingCost accounting > SetupSetup > ParametersParameters  >

GeneralGeneral . Select the Enable view access for cost object dimension membersEnable view access for cost object dimension members  parameter.

The settings for the access list hierarchy are used to control the data that is shown in the following areas:

Cost controlCost control  workspace (Client):

Data in forms that are used to drill through scenarios

Cost controlCost control  workspace (Mobile application):

Balances in cards
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Power BI:

Data that is shown in Power BI visualizations

Data Power BI visualizations that are embedded in the Dynamics 365 Finance client

Before the access list hierarchy can affect data in Power BI, access list hierarchy and row-level security in Power BI must

be paired. For more information, see Set up security for Cost accounting content pack.

The access list hierarchy doesn't help secure the export of data to Excel. Therefore, that reporting tool should be used

only by cost accountants and managers who must have full access to view the data.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/dev-itpro/analytics/setup-security-cost-accounting-content-pack.html
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create an organization report hierarchy
2/18/2021 • 2 minutes to read • Edit Online

Use this procedure to create a report hierarchy for organization reporting. The purpose of this recording is to

guide you through the dimension hierarchy so that you can continue until the whole organization reporting

structure is created. This recording uses the USP2 demo data company.

1. Go to Cost accounting > Dimensions > Dimension hierarchies.

2. Click New.

3. In the HierarchyTypeComboBox field, select 'Dimension classification hierarchy'.

4. Click Create.

5. In the Dimension hierarchy name field, type 'Oganization USP2'.

6. In the Dimension field, enter or select a value.

7. Click Save.

8. Click View hierarchy.

9. Click New.

10. In the Node name field, type 'CEO'.

11. Click Save.

12. Click New.

13. In the Node name field, type 'CEO cost centers'.

14. Click Save.

15. Click New.

16. In the Node name field, type 'Region East'.

17. Click Save.

18. Click New.

19. In the list, mark the selected row.

20. In the From dimension member field, enter or select a value.

21. Click Save.

22. In the tree, select 'Oganization USP2\CEO\CEO cost centers'.

23. Click New.

24. In the Node name field, type 'Region West'.

25. Click Save.

26. Click New.

27. In the list, mark the selected row.

28. In the From dimension member field, enter or select a value.

29. Click Save.

30. In the tree, select 'Oganization USP2\CEO'.

31. Click New.

32. In the Node name field, type 'CFO cost centers'.

Select Dimension classification hierarchy. The Dimension classification hierarchy type is used to define

rules and for reporting purposes. It supports all dimensions, such as cost objects, cost elements, and

statistical dimensions.

Select Cost centers.

Select the dimension member that corresponds to the node.

Select the dimension member that corresponds to the node.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/tasks/create-an-organization-report-hierarchy.md
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33. Click Save.

34. Click New.

35. In the Node name field, type 'Marketing campa'.

36. In the Node name field, type 'Marketing campaign'.

37. Click Save.

38. Click New.

39. In the list, mark the selected row.

40. In the From dimension member field, enter or select a value.

41. Click Save.

42. In the tree, select 'Organization USP2\CEO\CFO cost centers'.

43. Click New.

44. In the Node name field, type 'Trade shows'.

45. Click Save.

46. Click New.

47. In the list, mark the selected row.

48. In the From dimension member field, enter or select a value.

49. Click Save.

50. In the tree, select 'Oganization USP2\CEO'.

51. In the Node name field, type 'CIO cost centers'.

52. Click Save.

53. Click New.

54. In the Node name field, type 'Call centers'.

55. Click Save.

56. Click New.

57. In the list, mark the selected row.

58. In the From dimension member field, enter or select a value.

59. Click Save.

Select the dimension member that corresponds to the node.

Select the dimension member that corresponds to the node.

Select the dimension member that corresponds to the node.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Access rights for cost object controllers
2/18/2021 • 2 minutes to read • Edit Online

RO L E N A M ERO L E N A M E L IC EN SEL IC EN SE

Cost accounting manager Activity

Cost accountant Operations

Cost accountant clerk Operations

Cost object controller Team members

NOTENOTE

Grant access rights
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Organization Cost centers Dimension classification
hierarchy

YesYes

The Cost controlCost control  workspace is a central point where managers can view the performance of their cost objects.

This workspace lets managers consume Cost accounting data even though they aren't cost accountants. For

security reasons, managers should be allowed to see only the Cost accounting data that is related to the specific

cost objects that they are responsible for.

There are four unique roles in Cost accounting.

This topic explains how to assign the Cost object controllerCost object controller  role to a manager.

When the Cost object controllerCost object controller  role is assigned to a manager, the manager can perform the following tasks:

Access the Cost controlCost control  workspace (in the client).

Drill through and have view access to the pages that support the drill-through experience.

Access the Cost controlCost control  workspace (in the mobile application).

The Cost object controllerCost object controller  role doesn't control which cost objects the user can access and view data for. Row-level

security is provided via dimension hierarchies and the Access list hierarchy.

The following example shows what a dimension hierarchy can look like.

Dimension hierarchy detailsDimension hierarchy details

You can use the UsersUsers  FastTab in the hierarchy designer to insert one or more user IDs on each node.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/access-rights-cost-object-controller.md
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NodesNodes User IDUser ID From dimensionFrom dimension
membermember

To dimension memberTo dimension member

Organization Benjamin, Claire

  Admin April

    Finance Alicia CC002 CC003

CC007 CC007

    HR Arnie CC001 CC001

  Production David

    Packaging Ellen CC005 CC005

    Assembly Chris CC006 CC006
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IMPORTANTIMPORTANT

Cost accountants should be assigned to the top level of the hierarchy, so that they can see all entries in Cost accounting.

Before the Access list hierarchy and its security settings can be applied, the Enable view access for costEnable view access for cost

object dimension membersobject dimension members  option must be set to YesYes  on the GeneralGeneral  tab of the Cost accountingCost accounting

parametersparameters  page (Cost accountingCost accounting > SetupSetup > ParametersParameters ).

The settings for the Access list hierarchy are used to control the data that is shown in following areas:

Cost controlCost control  workspace (in the client):

Data on the pages that are used for drill-through

Cost controlCost control  workspace (in the mobile application):

Balances in cards

Microsoft Power BI:

Data that is shown in Power BI visualizations

Data Power BI visualizations that are embedded in the Dynamics 365 Finance client

Before the Access list hierarchy can affect data in Power BI, the Access list hierarchy and row-level security in Power BI

must be paired. For more information, see Set up security for Cost accounting content pack.

This topic shows the prerequisites that must be in place before you can use the Cost controlCost control workspace.

Additional resources

Cost control workspace

Dimension hierarchy

Set up security for Cost accounting content pack

file:///T:/eiye/ac1a/dynamics365/dev-itpro/analytics/setup-security-cost-accounting-content-pack.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/analytics/setup-security-cost-accounting-content-pack.html
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Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Configure access rights for a cost object controller
2/18/2021 • 2 minutes to read • Edit Online

Assign the cost object controller role

Enable access list security

Assign access rights to user

Enable access rights in Cost accounting

Use this procedure to configure access rights for a cost object controller. This recording uses the USP2 demo

data company.

1. Go to System administration > Users > Users.

2. Use the Quick Filter to find records. For example, filter on the User name field with a value of 'alicia'.

3. In the list, click the link in the selected row.

4. Click Assign roles.

5. In the list, find and select the desired record.

6. Click OK.

1. Go to Cost accounting > Dimensions > Dimension hierarchies.

2. In the list, find and select the desired record.

3. Click Edit.

4. Select Yes in the Access list hierarchy field.

5. Click View hierarchy.

Select Organization.

1. Click New.

2. In the list, mark the selected row.

3. In the User ID field, enter or select a value.

4. In the tree, select 'Organization\CEO\CFO\FIM'.

5. Click New.

6. In the list, mark the selected row.

7. In the User ID field, enter or select a value.

8. Click Save.

Select Admin.

Select Alicia.

1. Go to Cost accounting > Setup > Parameters.

2. Click the General tab.

3. Select Yes in the Enable view access for cost object dimension members field.

4. Click Save.

5. Close the page.

6. Go to Cost accounting > Setup > Cost control workspace configuration.

7. Click Edit.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/tasks/configure-access-rights-cost-object-controller.md
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8. Select Yes in the Published field.

9. Click Save.

If you select Yes, a user who is assigned one of the following four roles can see the reports in the Cost

control workspace: cost accounting manager, cost accountant, cost accountant clerk, and cost object

controller. If you select No, only a user who is assigned one of the following roles can see the reports:

cost accounting manager, cost accountant, and cost accountant clerk.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Define cost control units
2/18/2021 • 2 minutes to read • Edit Online

NOTENOTE

This procedure shows how to define cost control units in the cost accounting ledger. You select the cost object

dimension for which you want to control costs in the ledger. The cost object dimension members are

transformed into cost objects of the cost control units. The demo data company used to create this procedure is

USP2.

1. Go to Cost accounting > Ledger setup > Cost accounting ledgers.

2. In the list, find and select the desired record.

3. Click Control units.

4. Click New.

5. In the Name field, type a value.

6. In the Dimension field, enter or select a value.

7. Click Save.

8. Click New.

9. In the Name field, type a value.

10. In the Dimension field, enter or select a value.

11. Click Save.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/tasks/define-cost-control-units.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a cost accounting ledger
2/18/2021 • 2 minutes to read • Edit Online

NOTENOTE

A cost accounting ledger represents the overall reporting unit. It is defined by a cost element dimension,

statistical dimension, fiscal calendar, and currency. It is agnostic to the concept of legal entities. A legal entity and

its data can be associated with many cost accounting ledgers. This recording uses the USP2 demo data

company.

1. Go to Cost accounting > Ledger setup > Cost accounting ledgers.

2. Click New.

3. In the Name field, type a value.

4. In the Cost element dimension field, enter or select a value.

5. In the Fiscal calendar field, enter or select a value.

6. In the Accounting currency field, enter or select a value.

7. In the Exchange rate type field, enter or select a value.

8. In the Statistical dimension field, enter or select a value.

9. Click Save.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/tasks/create-cost-accounting-ledger.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Provider templates for statistical dimension
members and measure providers
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Statistical dimension

NOTENOTE

N A M EN A M E DATA  C O N N EC TO R F O R DIM EN SIO N  M EM B ERSDATA  C O N N EC TO R F O R DIM EN SIO N  M EM B ERS

Shared Statistical elements Imported dimension members

N A M EN A M E
A C C O UN T IN GA C C O UN T IN G
C URREN C YC URREN C Y

EXC H A N GE RAT EEXC H A N GE RAT E
T Y P ET Y P E

F ISC A LF ISC A L
C A L EN DA RC A L EN DA R

C O ST  EL EM EN TC O ST  EL EM EN T
DIM EN SIO NDIM EN SIO N

STAT IST IC A LSTAT IST IC A L
DIM EN SIO NDIM EN SIO N

Managerial
accounting

USD Constant
currency

Fiscal period Shared Cost
elements

Shared Statistical
elements

Statistical dimension members

A statistical dimension and its members are used to register and control non-monetary entries in Cost

accounting. Statistical dimension members can be used for two purposes:

As an allocation base in policies such as cost distribution or cost allocation

For reporting of non-monetary consumption

A statistical dimension has a unique name and a set of unique dimension members. The statistical dimension is

assigned to a Cost accounting ledger ID. This relationship ties all corresponding statistical dimension members

to the Cost accounting ledger. Therefore, all statistical entries will be created in the context of the Cost

accounting ledger.

A statistical dimension can be assigned to more than one Cost accounting ledger.

Here is an example of a statistical dimension.

Here is an example of a statistical dimension that has been assigned to a Cost accounting ledger.

A statistical dimension member represents an entity that you want to register non-monetary measures for.

These measures can be used either as an allocation base or just to report non-monetary values.

Statistical dimension members can be created manually. Alternatively, they can be imported from a file by using

the Data management import/export tool.

A statistical dimension member automatically becomes a predefined allocation base. It can be used as an

allocation base in policies or as input in other types of allocation bases.

Here are some examples of typical statistical dimension members.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/statistical-measure-provider-template.md


 

STAT IST IC A L  DIM EN SIO NSTAT IST IC A L  DIM EN SIO N
N A M EN A M E STAT IST IC A L  EL EM EN T SSTAT IST IC A L  EL EM EN T S DESC RIP T IO NDESC RIP T IO N UN ITUN IT

Shared Statistical elements FTE Full time employees Ea.

Shared Statistical elements Electricity Electricity consumption kWh

Shared Statistical elements Pack CC Packaging Cost center Hrs.

Statistical measure provider template

NOTENOTE

N A M EN A M E C O ST  C EN T ERC O ST  C EN T ER DESC RIP T IO NDESC RIP T IO N W O RKER T Y P EW O RKER T Y P E

Employee 1 CC001 HR Employee

Employee 2 CC002 FI Employee

Employee 3 CC002 FI Employee

Employee 4 CC003 IT Employee

Employee 5 CC003 IT Employee

Employee 6 CC002 FI Contractor

Statistical measures can originate from many kinds of sources. Dynamics 365 Finance is a great source to extract

statistical measures from. You can use a statistical measure provider template to easily configure the statistical

measures that you want to extract.

The definition of a statistical measure provider template is generic and can be reused in multiple statistical

dimension members.

All tables that contain financial dimensions can be used as sources for statistical measures.

Example: Count of employees per cost centerExample: Count of employees per cost center

The count of employees per cost center is a statistical measure that can be used for various purposes that

provide managerial insight:

A statistical reporting measure by cost center

An allocation base for various types of expenses

Internal cost rates by cost center :

Cost by employee

Revenue by employee

The HcmEmployment table holds a list of all employees in the instance. This table is a global table. Therefore, the

records aren't related to a specific data area ID.

Here is an example of employees in the HcmEmployment table.



Using the Count function

N A M EN A M E F UN C T IO NF UN C T IO N SO URC E TA B L ESO URC E TA B L E SUM  F IEL DSUM  F IEL D DAT E F IEL DDAT E F IEL D

FTEs Count HcmEmployment Not applicable Not applicable

SO URC E TA B L ESO URC E TA B L E F IEL DF IEL D C RIT ERIAC RIT ERIA

HcmEmployment Worker type Employee

NOTENOTE

N A M EN A M E DATA  C O N N EC TO RDATA  C O N N EC TO R STAT IST IC A L  DIM EN SIO N  M EM B ERSTAT IST IC A L  DIM EN SIO N  M EM B ER

FTEs D365FO Dynamics 365 Finance – Statistical
measures

FTEs

STAT IST IC A L  T EM P L AT E N A M ESTAT IST IC A L  T EM P L AT E N A M E

FTEs

When you create a Statistical measure provider templateStatistical measure provider template record, you must decide which function to use:

CountCount – A count of records per cost object is transferred.

SumSum – A sum for records per cost object is transferred. (The SumSum field and DateDate field are required.)

For example, a statistical measure provider template can be set up as follows.

You can also add one or more ranges to narrow the measures from the source table.

In this example, if you just want a count of all full-time employees (FTEs), you can add a range in the WorkerWorker

typetype field. In the Criter iaCriter ia field, select EmployeeEmployee to limit the output range as follows.

RangesRanges

Before you can get statistical measures into Cost accounting, you must establish the relation between the

statistical measure provider template and the statistical dimension member. This relation is created per Cost

accounting ledger and version. The relation consists of a data connector and a data provider. You can have

several data connectors and data providers per statistical dimension member.

In this example, we will create a relation only for the Actual versionActual version.

Go to Cost accounting ledgerCost accounting ledger  > Actual versionActual version > ManageManage > Statistical measuresStatistical measures  to establish the

relation. For this scenario, select the Dynamics 365 Finance – Statistical measuresDynamics 365 Finance – Statistical measures  data connector, because

we want to extract data from Finance.

Data sourceData source

Data provider configurationData provider configuration

After the source data for the statistical measure is processed, the following statistical entries are created in Cost

accounting.

JournalJournal



JO URN A LJO URN A L
JO URN A LJO URN A L
T Y P ET Y P E

F ISC A LF ISC A L
C A L EN DA RC A L EN DA R
P ERIO DP ERIO D Y EA RY EA R P ERIO DP ERIO D VERSIO NVERSIO N

DATADATA
C O N N EC TO RC O N N EC TO R
SO URC ESO URC E
EN T RIESEN T RIES

00001 Statistical
entry transfer
journal

Fiscal 2017 Period 1 CA ledger
USMF

FTEs

A C C O UN T IN G DAT EA C C O UN T IN G DAT E M A GN IT UDEM A GN IT UDE
STAT IST IC A LSTAT IST IC A L
EL EM EN TEL EM EN T DESC RIP T IO NDESC RIP T IO N C O ST  C EN T ERC O ST  C EN T ER

31-01-2017 1.00 FTEs Full time employees CC001

31-01-2017 2.00 FTEs Full time employees CC002

31-01-2017 2.00 FTEs Full time employees CC003

C O ST  O B JEC TC O ST  O B JEC T
A C C O UN T IN GA C C O UN T IN G
DAT EDAT E

STAT IST IC A LSTAT IST IC A L
DIM EN SIO NDIM EN SIO N
M EM B ERM EM B ER DESC RIP T IO NDESC RIP T IO N M A GN IT UDEM A GN IT UDE

CC001 HR 31-01-2017 FTEs Full time
employees

1.00

CC002 FI 31-01-2017 FTEs Full time
employees

2.00

CC003 IT 31-01-2017 FTEs Full time
employees

2.00

C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N M A GN IT UDEM A GN IT UDE A L LO C AT IO N  FA C TO RA L LO C AT IO N  FA C TO R

CC001 HR 1.00 (1/5) × Amount

CC002 FI 2.00 (2/5) × Amount

CC003 IT 2.00 (2/5) × Amount

Using the Sum function

Statistical entr y transfer journal entr iesStatistical entr y transfer journal entr ies

Statistical entr iesStatistical entr ies

If the FTEs predefined dimension member allocation basis is assigned as an allocation base in a cost distribution

rule, the cost will be distributed by using the following allocation factor.

A production cost center, CC010 (Packaging), is responsible for packaging the products before they are shipped

to customers. The direct labor cost is added to the products via the bill of materials (BOM) and route. The

indirect cost of running the cost center must also be allocated to the produced products. Often, the best

statistical measure for such an allocation is the number of registered production hours per product within the

given period.

The ProdRouteTrans table holds all production labor transactions per legal entity DataAreadID.



REF EREN C EREF EREN C E N UM B ERN UM B ER
O P ERAT IOO P ERAT IO
NN T Y P ET Y P E T IM ET IM E

P H Y SIC A LP H Y SIC A L
DAT EDAT E

P RO DUC TP RO DUC T
GRO UPGRO UP
( F IN A N C IA( F IN A N C IA
LL
DIM EN SIODIM EN SIO
N )N )

L EGA LL EGA L
EN T IT YEN T IT Y

Production
order

P0001 Packaging Time 8.00 01-01-
2017

Orange
juice B2B

USMF

Production
order

P0001 Packaging Time 8.00 02-01-
2017

Orange
juice B2B

USMF

Production
order

P0002 Packaging Time 4.00 03-01-
2017

Orange
juice
Consumer

USMF

Production
order

P0003 Packaging Time 4.00 03-01-
2017

Orange
juice
Consumer

USMF

Production
order

P0004 Reconst. Time 10.00 03-01-
2017

Orange
juice
Consumer

USMF

N A M EN A M E F UN C T IO NF UN C T IO N SO URC E TA B L ESO URC E TA B L E SUM  F IEL DSUM  F IEL D DAT E F IEL DDAT E F IEL D

Pack CC Sum ProdRouteTrans Hours Physical date

SO URC E TA B L ESO URC E TA B L E F IEL DF IEL D C RIT ERIAC RIT ERIA

ProdRouteTrans Operation Packaging

NOTENOTE

Here is an example of the ProdRouteTrans table.

When you create a Statistical measure provider templateStatistical measure provider template record, you must decide which function to use:

CountCount – A count of records per cost object is transferred.

SumSum – A sum for records per cost object is transferred. (The SumSum field and DateDate field are required.)

The statistical measure provider template can be set up as follows.

You can also add ranges to narrow the measures from the source table.

In this example, if you just want the sum of hours that are related to the CC010 Packaging cost center, you can

add a range in the OperationOperation field. In the Criter iaCriter ia field, select PackagingPackaging to limit the output range.

RangesRanges

Before you can get statistical measures into Cost accounting, you must establish the relation between the

statistical measure provider template and the statistical dimension member. This relation is created per Cost

accounting ledger and version. The relation consists of a data connector and a data provider. You can have

several data connectors and data providers per statistical dimension member.

In this example, we will create a relation only for the Actual versionActual version.



N A M EN A M E DATA  C O N N EC TO RDATA  C O N N EC TO R STAT IST IC A L  DIM EN SIO N  M EM B ERSTAT IST IC A L  DIM EN SIO N  M EM B ER

Pack CC D365FO Dynamics 365 Finance – Statistical
measures

Pack CC

STAT IST IC A L  T EM P L AT E N A M ESTAT IST IC A L  T EM P L AT E N A M E L EGA L  EN T IT YL EGA L  EN T IT Y

Pack CC USMF

JO URN A LJO URN A L
JO URN A LJO URN A L
T Y P ET Y P E

F ISC A LF ISC A L
C A L EN DA RC A L EN DA R
P ERIO DP ERIO D Y EA RY EA R P ERIO DP ERIO D VERSIO NVERSIO N

DATADATA
C O N N EC TO RC O N N EC TO R
SO URC ESO URC E
EN T RIESEN T RIES

00002 Statistical
entry transfer
journal

Fiscal 2017 Period 1 CA ledger
USMF

Pack CC

A C C O UN T IN G DAT EA C C O UN T IN G DAT E M A GN IT UDEM A GN IT UDE
STAT IST IC A LSTAT IST IC A L
EL EM EN TEL EM EN T DESC RIP T IO NDESC RIP T IO N P RO DUC T  GRO UPP RO DUC T  GRO UP

31-01-2017 16.00 Pack CC Packaging Cost
center

Orange juice B2B

31-01-2017 8.00 Pack CC Packaging Cost
center

Orange juice
Consumer

C O ST  O B JEC TC O ST  O B JEC T A C C O UN T IN G DAT EA C C O UN T IN G DAT E
STAT IST IC A LSTAT IST IC A L
DIM EN SIO N  M EM B ERDIM EN SIO N  M EM B ER DESC RIP T IO NDESC RIP T IO N M A GN IT UDEM A GN IT UDE

Orange juice B2B 31-01-2017 Pack CC Packaging Cost
center

16.00

Orange juice
Consumer

31-01-2017 Pack CC Packaging Cost
center

8.00

Go to Cost accounting ledgerCost accounting ledger  > Actual versionActual version > ManageManage > Statistical measuresStatistical measures  to establish the

relation. For this scenario, select the Dynamics 365 Finance – Statistical measuresDynamics 365 Finance – Statistical measures  data connector, because

we want to extract data from Finance.

Data sourceData source

The system recognizes that ProdRouteTrans is a table where each record belongs to a separate legal entity.

Therefore, you will be asked to select the legal entity that transactions should be imported from.

Data provider configurationData provider configuration

After the source data for the statistical measure processed, the following statistical entries are created in Cost

accounting.

JournalJournal

Statistical entr y transfer journal entr iesStatistical entr y transfer journal entr ies

Statistical entr iesStatistical entr ies

If the Pack CC predefined dimension member allocation basis is assigned as an allocation base in a cost

distribution rule, the cost will be distributed by using the following allocation factor.



C O ST  O B JEC TC O ST  O B JEC T M A GN IT UDEM A GN IT UDE A L LO C AT IO N  FA C TO RA L LO C AT IO N  FA C TO R

Orange juice B2B 16.00 (16 ÷ 24) × Amount

Orange juice Consumer 8.00 (8 ÷ 24) × Amount

Imported statistical measures

NOTENOTE

A C C O UN T IN GA C C O UN T IN G
DAT EDAT E

DIM EN SIO NDIM EN SIO N
M EM B ER N A M E1M EM B ER N A M E1

DIM EN SIO NDIM EN SIO N
M EM B ER N A M E2M EM B ER N A M E2

DIM EN SIO NDIM EN SIO N
M EM B ER N A M E5M EM B ER N A M E5 M A GN IT UDEM A GN IT UDE

SO URC ESO URC E
IDEN T IF IERIDEN T IF IER

31-01-2017 CC001 2,450.00 Electricity

31-01-2017 CC002 4,100.00 Electricity

31-01-2017 CC003 15,000.00 Electricity

SO URC ESO URC E
IDEN T IF IERIDEN T IF IER

A C C O UN T IN GA C C O UN T IN G
DAT EDAT E M A GN IT UDEM A GN IT UDE

DIM EN SIO NDIM EN SIO N
M EM B ER N A M E1M EM B ER N A M E1

DIM EN SIO NDIM EN SIO N
M EM B ER N A M E2M EM B ER N A M E2

DIM EN SIO NDIM EN SIO N
M EM B ER N A M E5M EM B ER N A M E5

Electricity 31-01-2017 2,450.00 CC001

Electricity 31-01-2017 4,100.00 CC002

Electricity 31-01-2017 15,000.00 CC003

NOTENOTE

You can import statistical measures into Cost accounting by using the Data management import/export tool.

The data entity that is used for the import is named Imported statistical measures.

This data entity is designed to allow a maximum of five unique dimension values per entry.

The consumption of electricity is recorded in Microsoft Excel by using the predefined format of the data entity.

Here is an example.

When you've imported your data via Data management, the data will be stored in a Cost accounting staging

table. Therefore, the imported data can be used in multiple Cost accounting ledgers. A reload of data isn't

required.

To import the data, go to Impor ted dataImpor ted data > Data entityData entity  > Impor ted statistical measuresImpor ted statistical measures .

Before you can get statistical measures into Cost accounting, you must establish the relation between the source

identifier and the statistical dimension member. This relation is created per Cost accounting ledger and version.

The relation consists of a data connector and a data provider. You can have several data connectors and data

providers per statistical dimension member.

In this example, we will create a relation only for the Actual versionActual version.

Go to Cost accounting ledgerCost accounting ledger  > Actual versionActual version > ManageManage > Statistical measuresStatistical measures  to establish the



N A M EN A M E DATA  C O N N EC TO RDATA  C O N N EC TO R STAT IST IC A L  DIM EN SIO N  M EM B ERSTAT IST IC A L  DIM EN SIO N  M EM B ER

Electricity Imported statistical measures Electricity

IM P O RT  SO URC EIM P O RT  SO URC E
IDEN T IF IERIDEN T IF IER F UN C T IO NF UN C T IO N DIM EN SIO N 1DIM EN SIO N 1 DIM EN SIO N 2DIM EN SIO N 2 DIM EN SIO N 5DIM EN SIO N 5

Electricity Sum Cost centers

NOTENOTE

JO URN A LJO URN A L
JO URN A LJO URN A L
T Y P ET Y P E

F ISC A LF ISC A L
C A L EN DA RC A L EN DA R
P ERIO DP ERIO D Y EA RY EA R P ERIDP ERID VERSIO NVERSIO N

DATADATA
C O N N EC TO RC O N N EC TO R
SO URC ESO URC E
EN T RIESEN T RIES

00002 Statistical
entry transfer
journal

Fiscal 2017 Period 1 CA ledger
USMF

Electricity

A C C O UN T IN G DAT EA C C O UN T IN G DAT E M A GN IT UDEM A GN IT UDE C O ST  EL EM EN TC O ST  EL EM EN T DESC RIP T IO NDESC RIP T IO N C O ST  C EN T ERC O ST  C EN T ER

31-01-2017 2,450.00 Electricity Electricity
consumption

CC001

31-01-2017 4,100.00 Electricity Electricity
consumption

CC002

31-01-2017 15,000.00 Electricity Electricity
consumption

CC003

C O ST  O B JEC TC O ST  O B JEC T
A C C O UN T IN GA C C O UN T IN G
DAT EDAT E

STAT IST IC A LSTAT IST IC A L
DIM EN SIO NDIM EN SIO N
M EM B ERM EM B ER DESC RIP T IO NDESC RIP T IO N M A GN IT UDEM A GN IT UDE

CC001 HR 31-01-2017 Electricity Electricity
consumption

2,450.00

relation. For this scenario, select the Impor ted statistical measuresImpor ted statistical measures  data connector, because data has been

imported from a third-party system into Cost accounting via Excel.

Data sourceData source

Data provider configurationData provider configuration

When you define the data provider configuration, you must specify which cost object dimensions to match against the

imported transactions. After the source data for the statistical measure is processed, the following statistical entries are

created in Cost accounting.

JournalJournal

Statistical entr y transfer journal entr iesStatistical entr y transfer journal entr ies

Statistical entr iesStatistical entr ies



CC002 FI 31-01-2017 Electricity Electricity
consumption

4,100.00

CC003 IT 31-01-2017 Electricity Electricity
consumption

15,000.00

C O ST  O B JEC TC O ST  O B JEC T
A C C O UN T IN GA C C O UN T IN G
DAT EDAT E

STAT IST IC A LSTAT IST IC A L
DIM EN SIO NDIM EN SIO N
M EM B ERM EM B ER DESC RIP T IO NDESC RIP T IO N M A GN IT UDEM A GN IT UDE

C O ST  O B JEC TC O ST  O B JEC T M A GN IT UDEM A GN IT UDE A L LO C AT IO N  FA C TO RA L LO C AT IO N  FA C TO R

CC001 HR 2,450.00 (2,450 ÷ 21,550) × Amount

CC002 FI 4,100.00 (4,100 ÷ 21,550) × Amount

CC003 IT 15,000.00 (15,000 ÷ 21,550) ×
Amount

Additional resources

NOTENOTE

If the Electricity predefined dimension member allocation basis is assigned as an allocation base in a cost

distribution rule, the cost will be distributed by using the following allocation factor.

Allocation bases

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Allocation bases
2/18/2021 • 11 minutes to read • Edit Online

Predefined dimension member allocation bases

NOTENOTE

Example 1: Use a cost element dimension member as the allocation baseExample 1: Use a cost element dimension member as the allocation base

C H A RT  O F  A C C O UN TC H A RT  O F  A C C O UN T M A IN  A C C O UN TM A IN  A C C O UN T DESC RIP T IO NDESC RIP T IO N M A IN  A C C O UN T  T Y P EM A IN  A C C O UN T  T Y P E

Shared 10001 Salaries Expense

Shared 10002 Employee insurance Expense

C O ST  EL EM EN TC O ST  EL EM EN T
DIM EN SIO N  N A M EDIM EN SIO N  N A M E C O ST  EL EM EN TC O ST  EL EM EN T DESC RIP T IO NDESC RIP T IO N T Y P ET Y P E

Cost elements 10001 Salaries Primary

An allocation base is the basis on which Cost accounting allocates overhead costs. An allocation base can be a

quantity, such as machine hours that are used, kilowatt hours (kWh) that are consumed, or square footage that

is occupied. Allocation bases are mostly used to assign overhead costs to inventory that is produced. For

example, an IT department allocates its expenses according to the number of computers that each department

uses.

There are three types of allocation bases in Cost accounting:

Predefined dimension member allocation bases

Hierarchy allocation bases

Formula allocation bases

The predefined dimension member allocation bases are created automatically when a dimension member of

one the following types is created:

Statistical dimension members

Cost element dimension members

The predefined dimension member allocation bases that are based on a cost element dimension member consider the

values only from the data source provider, such as the general ledger or budget.

This example shows how to create a cost allocation rule to allocate cost element 10002 (Employee insurance) to

the balance that is recorded on cost element 10001 (Salaries). The allocation rule is defined based on the ratio of

each department's salaries to total salaries. (Review needed!)

In the general ledger, the chart of account is defined as follows.

Define a cost element dimension, and configure the data connector. After the data is imported, the following

entries are created in Cost accounting.

Cost element dimension membersCost element dimension members

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/allocation-bases.md


Cost elements 10002 Employee insurance Primary

C O ST  EL EM EN TC O ST  EL EM EN T
DIM EN SIO N  N A M EDIM EN SIO N  N A M E C O ST  EL EM EN TC O ST  EL EM EN T DESC RIP T IO NDESC RIP T IO N T Y P ET Y P E

N A M EN A M E DESC RIP T IO NDESC RIP T IO N C O ST  EL EM EN T  DIM EN SIO NC O ST  EL EM EN T  DIM EN SIO N

10001 Salaries Cost elements

10002 Employee insurance Cost elements

A C C O UN T IN GA C C O UN T IN G
DAT EDAT E C O ST  C EN T ERC O ST  C EN T ER DESC RIP T IO NDESC RIP T IO N M A IN  A C C O UN TM A IN  A C C O UN T DESC RIP T IO NDESC RIP T IO N

A M O UN T  INA M O UN T  IN
A C C O UN T IN GA C C O UN T IN G
C URREN C YC URREN C Y

03-01-2017 CC001 HR 10001 Salaries 2,000.00

03-01-2017 CC002 FI 10001 Salaries 5,000.00

03-01-2017 CC003 IT 10001 Salaries 3,000.00

03-01-2017 CC099 Default cost
center

10002 Employee
insurance

1,000.00

C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N
C O STC O ST
EL EM EN TEL EM EN T DESC RIP T IO NDESC RIP T IO N

C O STC O ST
B EH AVIO RB EH AVIO R A M O UN TA M O UN T

A C C O UN T IN GA C C O UN T IN G
DAT EDAT E

CC001 HR 10001 Salaries Unclassified 2,000.00 03-01-2017

CC002 FI 10001 Salaries Unclassified 5,000.00 03-01-2017

CC003 IT 10001 Salaries Unclassified 3,000.00 03-01-2017

CC099 Default cost
center

10002 Employee
insurance

Unclassified 1,000.00 03-01-2017

Predefined dimension member allocation basesPredefined dimension member allocation bases

In the general ledger, the following entries have been posted:

The entries that show the Salaries main account come from the Payroll system and are posted to cost centers.

The expense for employee insurance is manually posted to a default cost center.

After the general ledger source data is processed, the following entries are created in Cost accounting.

Cost entr iesCost entr ies

In this simplified example, a cost allocation rule is created to allocate cost element 10002 (Employee insurance)

relative to the balance that is recorded on cost element 10001 (Salaries).

Cost distr ibution ruleCost distr ibution rule



C O ST  O B JEC T  DIM EN SIO NC O ST  O B JEC T  DIM EN SIO N
H IERA RC H Y  N O DEH IERA RC H Y  N O DE

C O ST  EL EM EN TC O ST  EL EM EN T
DIM EN SIO N  H IERA RC H YDIM EN SIO N  H IERA RC H Y
N O DEN O DE C O ST  B EH AVIO RC O ST  B EH AVIO R A L LO C AT IO N  B A SEA L LO C AT IO N  B A SE

CC099 10002 Unclassified 10001

C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N M A GN IT UDEM A GN IT UDE
A L LO C AT IO NA L LO C AT IO N
FA C TO RFA C TO R A M O UN TA M O UN T

CC001 HR 2,000 (2,000 ÷ 10,000) ×
1,000.00

200.00

CC002 FI 5,000 (5,000 ÷ 10,000) ×
1,000.00

500.00

CC003 IT 3,000 (3,000 ÷ 10,000) ×
1,000.00

300.00

JO URN A LJO URN A L JO URN A L  T Y P EJO URN A L  T Y P E

F ISC A LF ISC A L
C A L EN DA RC A L EN DA R
P ERIO DP ERIO D Y EA RY EA R P ERIO DP ERIO D VERSIO NVERSIO N

00001 Cost distribution
calculation
journal

Fiscal 2017 Period 1 Overhead
calculation / 01-
02-2017
11:51:00 PM /
Ledger /2017 /
Period 1

A C C O UN T INA C C O UN T IN
G DAT EG DAT E C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N

C O STC O ST
EL EM EN TEL EM EN T DESC RIP T IO NDESC RIP T IO N

C O STC O ST
B EH AVIO RB EH AVIO R A M O UN TA M O UN T

31-01-2017 CC099 Default cost
center

10002 Employee
insurance

Unclassified 1,000.00

C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N
C O STC O ST
EL EM EN TEL EM EN T DESC RIP T IO NDESC RIP T IO N

C O STC O ST
B EH AVIO RB EH AVIO R A M O UN TA M O UN T

A C C O UN T IN GA C C O UN T IN G
DAT EDAT E

CC099 Default cost
center

10002 Employee
insurance

Unclassified -1,000.00 31-01-2017

CC001 HR 10002 Employee
insurance

Unclassified 200.00 31-01-2017

CC002 FI 10002 Employee
insurance

Unclassified 500.00 31-01-2017

Perform overhead calculationPerform overhead calculation

After cost element 10001 (Salaries) is applied as the allocation base, the result of the overhead calculation is as

follows.

JournalJournal

Cost object balance journal entr iesCost object balance journal entr ies

Cost entr iesCost entr ies



CC099 IT 10002 Employee
insurance

Unclassified 300.00 31-01-2017

C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N
C O STC O ST
EL EM EN TEL EM EN T DESC RIP T IO NDESC RIP T IO N

C O STC O ST
B EH AVIO RB EH AVIO R A M O UN TA M O UN T

A C C O UN T IN GA C C O UN T IN G
DAT EDAT E

Example 2: Use a statistical dimension member as the allocation baseExample 2: Use a statistical dimension member as the allocation base

STAT IST IC A L  DIM EN SIO NSTAT IST IC A L  DIM EN SIO N
N A M EN A M E STAT IST IC A L  EL EM EN TSTAT IST IC A L  EL EM EN T DESC RIP T IO NDESC RIP T IO N UN ITUN IT

Statistical elements FTE Full time employees Ea

Statistical elements Electricity Electricity consumption kWh

N A M EN A M E DESC RIP T IO NDESC RIP T IO N STAT IST IC A L  EL EM EN T  DIM EN SIO NSTAT IST IC A L  EL EM EN T  DIM EN SIO N

FTE Full time employees Statistical elements

Electricity Electricity consumption Statistical elements

N A M EN A M E C O ST  C EN T ERC O ST  C EN T ER DESC RIP T IO NDESC RIP T IO N W O RKER T Y P EW O RKER T Y P E

Employee A CC001 HR Employee

Employee B CC002 FI Employee

Employee C CC002 FI Employee

Employee D CC003 IT Employee

Employee F CC003 IT Employee

NOTENOTE

Statistical dimension members can be used as allocation bases to define policies or report non-monetary

consumption by cost objects. You can manually create statistical dimension members or import them from a file

by using the Data management import/export tool.

Statistical dimension membersStatistical dimension members

When a statistical dimension member is saved, a corresponding record is created in the predefined dimension

member allocation bases.

Predefined dimension member allocation basesPredefined dimension member allocation bases

Statistical measures can come from various sources:

Electricity consumption can be measured by meters that are installed in different areas of the company.

Tables hold statistical measures. For example, the HcmEmployment table holds a list of all employees and the

cost centers that they work for.

All the tables that contain financial dimensions can be used as sources for statistical measures.

Cost accounting supports a collection of statistical measures by using the following data connections:



N A M EN A M E F UN C T IO NF UN C T IO N SO URC E TA B L ESO URC E TA B L E SUM  F IEL DSUM  F IEL D DAT E F IEL DDAT E F IEL D

FTE’s Count HcmEmployment Not applicable Not applicable

C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N
A C C O UN T IN GA C C O UN T IN G
DAT EDAT E

STAT IST IC A LSTAT IST IC A L
DIM EN SIO NDIM EN SIO N
M EM B ERM EM B ER DESC RIP T IO NDESC RIP T IO N M A GN IT UDEM A GN IT UDE

CC001 HR 31-01-2017 FTE’s Full time
employees

1.00

CC002 FI 31-01-2017 FTE’s Full time
employees

2.00

CC003 IT 31-01-2017 FTE’s Full time
employees

2.00

C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N M A GN IT UDEM A GN IT UDE A L LO C AT IO N  FA C TO RA L LO C AT IO N  FA C TO R

CC001 HR 1.00 (1/5) × Amount

CC002 FI 2.00 (2/5) × Amount

CC003 IT 2.00 (2/5) × Amount

A C C O UN T IN G DAT EA C C O UN T IN G DAT E DIM EN SIO N  M EM B ERDIM EN SIO N  M EM B ER M A GN IT UDEM A GN IT UDE SO URC E IDEN T IF IERSO URC E IDEN T IF IER

31-01-2017 CC001 2,450.00 Electricity

31-01-2017 CC002 4,100.00 Electricity

31-01-2017 CC003 15,000.00 Electricity

Data management import/export tool

Statistical measures

To pull statistical measures from the system, a statistical measure provider template is required. For more

information, see Statistical measure provider template. (Will add a link once this topic is written.)

Statistical measure provider templatesStatistical measure provider templates

After the statistical measure source data is processed, the following entries will be created in Cost accounting.

Statistical entr iesStatistical entr ies

Here is an example of a cost distribution rule if the FTE’s predefined dimension member allocation basis is

assigned as the allocation base in it.

You can use the Imported statistical measures data entity to import statistical measures into Cost accounting.

You can also use the Data management import/export tool. In Excel, the consumption of electricity is recorded as

follows.

After the statistical measure source data is processed, the following entries will be created in Cost accounting.

Statistical entr iesStatistical entr ies



C O ST  O B JEC TC O ST  O B JEC T
A C C O UN T IN GA C C O UN T IN G
DAT EDAT E

STAT IST IC A LSTAT IST IC A L
DIM EN SIO NDIM EN SIO N
M EM B ERM EM B ER DESC RIP T IO NDESC RIP T IO N M A GN IT UDEM A GN IT UDE

CC001 HR 31-01-2017 Electricity Electricity
consumption

2,450.00

CC002 FI 31-01-2017 Electricity Electricity
consumption

4,100.00

CC003 IT 31-01-2017 Electricity Electricity
consumption

15,000.00

C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N M A GN IT UDEM A GN IT UDE A L LO C AT IO N  FA C TO RA L LO C AT IO N  FA C TO R

CC001 HR 2,450.00 (2,450 ÷ 21,550) × Amount

CC002 FI 4,100.00 (4,100 ÷ 21,550) × Amount

CC003 IT 15,000.00 (15,000 ÷ 21,550) ×
Amount

Hierarchy allocation bases

Example: Hierarchy allocation bases that are based on full-time employees in the organizationExample: Hierarchy allocation bases that are based on full-time employees in the organization

H IERA RC H Y  N A M EH IERA RC H Y  N A M E N O DE L EVEL  0N O DE L EVEL  0 N O DE L EVEL  1N O DE L EVEL  1 N O DE L EVEL  2N O DE L EVEL  2
DIM EN SIO NDIM EN SIO N
M EM B ERSM EM B ERS

Organization CEO CFO FICO CC001

Organization CEO CFO HR CC002

Organization CEO CIO IT CC003

Here is an example of a cost distribution rule if the Electricity predefined dimension member allocation basis is

assigned as the allocation base in it.

Cost accountants can manually create the hierarchy allocation bases by applying a cost object dimension

hierarchy node to an existing allocation base. In this way, you can limit the range of the original predefined

dimension member allocation basis. One predefined dimension member allocation basis can be used to create

several hierarchy allocation bases. Ranges can be maintained in the cost object dimension hierarchy that is

associated with the hierarchy allocation bases.

Here is an example of a cost object dimension hierarchy that can be created to describe a simplified

organization.

The FTE’s predefined dimension member allocation basis that was created in the previous section holds the

following entries.

Statistical entr iesStatistical entr ies



C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N
A C C O UN T IN GA C C O UN T IN G
DAT EDAT E

STAT IST IC A LSTAT IST IC A L
DIM EN SIO NDIM EN SIO N
M EM B ERM EM B ER DESC RIP T IO NDESC RIP T IO N M A GN IT UDEM A GN IT UDE

CC001 HR 31-01-2017 FTE’s Full time
employees

1.00

CC002 FI 31-01-2017 FTE’s Full time
employees

2.00

CC003 IT 31-01-2017 FTE’s Full time
employees

2.00

N A M EN A M E A L LO C AT IO N  B A SEA L LO C AT IO N  B A SE
C O ST  O B JEC T  DIM EN SIO NC O ST  O B JEC T  DIM EN SIO N
H IERA RC H YH IERA RC H Y

C O ST  O B JEC T  DIM EN SIO NC O ST  O B JEC T  DIM EN SIO N
H IERA RC H Y  N O DEH IERA RC H Y  N O DE

Number of FTEs in CFO FTE’s Organization CFO

C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N M A GN IT UDEM A GN IT UDE

CC001 HR 1.00

CC002 FI 2.00

C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N M A GN IT UDEM A GN IT UDE A L LO C AT IO N  FA C TO RA L LO C AT IO N  FA C TO R

CC001 HR 1.00 (1/3) × Amount

CC002 FI 2.00 (2/3) × Amount

Formula allocation bases

NOTENOTE

A cost must be distributed between cost centers that report to the organization's chief financial officer (CFO). It's

acknowledged that the correct allocation ratio is the number of full-time employees (FTEs) by cost center.

Hierarchy allocation basesHierarchy allocation bases

A Preview function lets you validate the hierarchy allocation basis that is created, based on statistical entries in

the system.

Allocation base detailsAllocation base details

Here is an example of a cost distribution rule if the Number of FTEs in CFO hierarchy allocation basis is assigned

as the allocation base in it.

Formula allocation bases let you define advanced formulas to achieve the correct allocation basis. You can

manually create formula allocation bases.

When you create a formula allocation base, you select which statistical dimension and cost element dimension

should be the basis for the formula. All allocation bases that come from the previously selected dimensions can

be used in a formula allocation base.

Previously defined formula allocation bases can be used to define a new formula allocation base.



SY M B O L SSY M B O L S T EXTT EXT

( ) Parentheses

< Smaller than

> Larger than

+ Addition

– Subtraction

* Multiplication

STAT EM EN TSTAT EM EN T VA L IDAT IO NVA L IDAT IO N RESULTRESULT

a > b True 1

a > b False 0

Example 1: A simple formulaExample 1: A simple formula

C O ST  O B JEC TC O ST  O B JEC T N A M EN A M E
A C C O UN T IN GA C C O UN T IN G
DAT EDAT E

STAT IST IC A LSTAT IST IC A L
DIM EN SIO NDIM EN SIO N
M EM B ERM EM B ER DESC RIP T IO NDESC RIP T IO N M A GN IT UDEM A GN IT UDE

CC001 HR 31-01-2017 Electricity Electricity
consumption

2,450.00

CC002 FI 31-01-2017 Electricity Electricity
consumption

4,100.00

CC003 IT 31-01-2017 Electricity Electricity
consumption

15,000.00

In formula allocation base factors, you create an alias, and associate it with either an allocation base or a

constant. The aliases are then used to define the formula.

You can use the following operators to define your formula.

Traditional IFIF  statements aren't supported. However, you can create statements and validate whether they are

true.

Electricity bills often consist of two parts:

A fixed fee for being connected to grid

A cost that is associated with consumption per kWh

The Electricity predefined dimension member allocation basis has already been defined and holds these values.

Statistical entr iesStatistical entr ies

If the fixed fee must now be evenly spread over cost objects that consume electricity, you have two options for

allocating the costs:

Create a new predefined allocation base, Electricity fixed, and then apply a statistical measure of 1.00 for each

cost object that consumed electricity.



N A M EN A M E
C O ST  EL EM EN TC O ST  EL EM EN T
DIM EN SIO NDIM EN SIO N STAT IST IC A L  DIM EN SIO NSTAT IST IC A L  DIM EN SIO N F O RM UL AF O RM UL A

Electricity fixed Statistical elements

A L IA SA L IA S C O N STA N TC O N STA N T A L LO C AT IO N  B A SEA L LO C AT IO N  B A SE

a Electricity

b 0.01

N A M EN A M E
C O ST  EL EM EN TC O ST  EL EM EN T
DIM EN SIO NDIM EN SIO N STAT IST IC A L  DIM EN SIO NSTAT IST IC A L  DIM EN SIO N F O RM UL AF O RM UL A

Electricity fixed Statistical elements a > b

C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N F O RM UL AF O RM UL A M A GN IT UDEM A GN IT UDE

CC001 HR 2,450.00 > 0.01 1.00

CC002 FI 4,100.00 > 0.01 1.00

CC003 IT 15,000.00 > 0.01 1.00

C O ST  O B JEC TC O ST  O B JEC T N A M EN A M E M A GN IT UDEM A GN IT UDE A L LO C AT IO N  FA C TO RA L LO C AT IO N  FA C TO R

CC001 HR 1.00 (1/3) × Amount

CC002 FI 1.00 (1/3) × Amount

CC003 IT 1.00 (1/3) × Amount

Create a formula allocation base, Electricity fixed, that takes advantage of the Electricity predefined allocation

base that is already defined in the system. The benefit of this option is that data must be loaded into Cost

accounting for only one Electricity statistical dimension member.

Formula allocation baseFormula allocation base

Before the FormulaFormula field can be filled, you must specify the alias that should be used in the formula.

Formula allocation base factorsFormula allocation base factors

Note that 0 (zero) isn't supported as a constant.

Formula allocation baseFormula allocation base

A Preview function lets you validate the formula allocation base that is created, based on statistical entries in the

system.

Allocation base detailsAllocation base details

Here is an example of a cost distribution rule if the Electricity formula allocation base is assigned as the

allocation base in it.

Cost object magnitude allocation factorCost object magnitude allocation factor



Example 2: An advanced formulaExample 2: An advanced formula

RUL ERUL E RAT ERAT E

a <= 10000,00 kWh 0.75

a > 10000,00 kWh 1.15

N A M EN A M E
C O ST  EL EM EN TC O ST  EL EM EN T
DIM EN SIO NDIM EN SIO N STAT IST IC A L  DIM EN SIO NSTAT IST IC A L  DIM EN SIO N F O RM UL AF O RM UL A

Electricity usage Statistical elements

A L IA SA L IA S C O N STA N TC O N STA N T A L LO C AT IO N  B A SEA L LO C AT IO N  B A SE

a Electricity

b 10,000.00

c 0.75

d 1.15

N A M EN A M E
C O ST  EL EM EN TC O ST  EL EM EN T
DIM EN SIO NDIM EN SIO N STAT IST IC A L  DIM EN SIO NSTAT IST IC A L  DIM EN SIO N F O RM UL AF O RM UL A

Electricity fixed Statistical elements ((a > b) × ((b × c) + (a – b)
× d)) + ((a <= b] × a × c)

C O ST  O B JEC TC O ST  O B JEC T F O RM UL AF O RM UL A M A GN IT UDEM A GN IT UDE

CC001 HR ((2,450.00 > 10.000.00) ×
((10,000.00 × 0.75) +
(2,450.00 – 10,000.00) ×
1.15)) + ((2,450.00 <=
10,000.00) × 2,450.00 ×
0.75)

1,837.50

For this example, the cost of electricity should not just follow the actual electricity that is consumed in kWh.

Management wants to incorporate incentive for lowering electricity usage.

A new formula allocation base, Electricity usage, is created.

Formula allocation baseFormula allocation base

Before the FormulaFormula field can be filled, you must specify the alias that should be used in the formula.

Formula allocation base factorsFormula allocation base factors

Formula allocation baseFormula allocation base

A Preview function lets you validate the formula allocation base that is created, based on statistical entries in the

system.

Allocation base detailsAllocation base details



CC002 FI ((4,100.00 > 10.000.00) ×
((10,000.00 × 0.75) +
(4,100.00 – 10,000.00) ×
1.15)) + ((4,100.00 <=
10,000.00) × 4,100.00 ×
0.75)

3,075.00

CC003 IT ((15,000.00 > 10.000.00) ×
((10,000.00 × 0.75) +
(15,000.00 – 10,000.00) ×
1.15)) + ((15,000.00 <=
10,000.00) × 15,000.00 ×
0.75)

1,3250.00

C O ST  O B JEC TC O ST  O B JEC T F O RM UL AF O RM UL A M A GN IT UDEM A GN IT UDE

C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N M A GN IT UDEM A GN IT UDE A L LO C AT IO N  FA C TO RA L LO C AT IO N  FA C TO R

CC001 HR 1,837.50 (1,837.50 ÷ 18,162.50) ×
Amount

CC002 FI 3,075.00 (3,075.00 ÷ 18,162.50) ×
Amount

CC003 IT 13,250.00 (13,250.00 ÷ 18,162.50) ×
Amount

NOTENOTE

Here is a closer look at the formula for CC003 (IT):

((15,000.00 > 10,000.00) × ((10,000.00 × 0.75) + (15,000.00 – 10,000.00) × 1.15)) + ((15,000.00 <= 10,000.00)

× 15,000.00 × 0.75) = 13,250.00

(1 × (7,500.00 + 5,000.00 × 1.15)) + (0 × 15,000.00 × 0.75)

1 × 7,500.00 + 5,750.00 + 0

Here is an example of a cost distribution rule if the Electricity fixed formula allocation base is assigned as the

allocation base in it.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create and assign a cost allocation policy to a cost
control unit
2/18/2021 • 2 minutes to read • Edit Online

Create a policy

Create allocation rules

Assign the policy to a cost control unit

Use this procedure to create and assign a cost allocation policy and the corresponding rules to a cost control

unit. This recording uses the USP2 demo data company.

1. Go to Cost accounting > Policies > Cost allocation policies.

2. Click New.

3. In the Policy name field, type a value.

4. In the Cost object dimension hierarchy field, enter or select a value.

5. In the Statistical dimension field, enter or select a value.

6. Click Save.

Select Organization.

1. Click New.

2. In the list, mark the selected row.

3. In the Cost object dimension hierarchy node field, enter or select a value.

4. In the Cost behavior field, select 'Total'.

5. In the Allocation base field, enter or select a value.

6. Click New.

7. In the list, mark the selected row.

8. In the Cost object dimension hierarchy node field, enter or select a value.

9. In the Cost behavior field, select 'Total'.

10. In the Allocation base field, enter or select a value.

11. Click New.

12. In the list, mark the selected row.

13. In the Cost object dimension hierarchy node field, enter or select a value.

14. In the Cost behavior field, select 'Total'.

15. In the Allocation base field, enter or select a value.

16. Click Save.

Continue until you've created all the rules.

1. Click Policy assignments for cost control unit.

2. Click New.

3. In the list, mark the selected row.

4. In the Valid from accounting date field, enter a date.

5. In the Cost control unit field, enter or select a value.

The rules are date-effective. A user or the system can expire the rules if a newer version is created.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/tasks/create-assign-cost-allocation-policy-cost-control-unit.md


NOTENOTE

6. Click Save.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create and assign a cost behavior policy to a cost
control unit
2/18/2021 • 2 minutes to read • Edit Online

Create a cost behavior hierarchy

Create the policy and rules

Cost behavior is the classification of costs as either fixed or variable. A policy and the corresponding rules have

to be assigned to a cost control unit for the policy to become effective. Use this procedure to create a policy and

then assign the policy to a cost control unit.

1. Go to Cost accounting > Dimensions > Dimension hierarchies.

2. Click New.

3. Click Create.

4. In the Dimension hierarchy name field, type 'Cost behavior hierarchy'.

5. In the Dimension field, enter or select a value.

6. Click Save.

7. Click View hierarchy.

8. Click New.

9. In the Node name field, type a value.

10. In the tree, select 'Cost behavior hierarchy'.

11. Click New.

12. In the Node name field, type a value.

13. Click Save.

14. In the tree, select 'Cost behavior hierarchy\Fixed cost'.

15. Click New.

16. In the list, mark the selected row.

17. In the From dimension member field, enter or select a value.

18. In the To dimension member field, enter or select a value.

19. In the tree, select 'Cost behavior hierarchy\Variable cost'.

20. Click New.

21. In the list, mark the selected row.

22. In the From dimension member field, enter or select a value.

23. In the To dimension member field, enter or select a value.

24. Click Save.

Select Cost elements.

Enter Fixed cost.

Enter Variable cost.

The range of dimension members can contain gaps, but the members cannot overlap.

The range of dimension members can contain gaps, but the members cannot overlap.

The range of dimension members can contain gaps, but the members cannot overlap.

The range of dimension members can contain gaps, but the members cannot overlap.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/tasks/create-assign-cost-behavior-policy-cost-control-unit.md


NOTENOTE

1. Go to Cost accounting > Policies > Cost behavior policies.

2. Click New.

3. In the Policy name field, type a value.

4. In the Cost element dimension hierarchy field, enter or select a value.

5. In the Cost object dimension hierarchy field, enter or select a value.

6. Click Save.

7. Click New.

8. In the list, mark the selected row.

9. In the Cost element dimension hierarchy node field, enter or select a value.

10. In the Cost object dimension hierarchy node field, enter or select a value.

11. Click Policy assignments for cost control unit.

12. Click New.

13. In the list, mark the selected row.

14. In the Valid from accounting date field, enter a date.

15. In the Cost control unit field, enter or select a value.

16. Click Save.

Select the policy hierarchy that you just created.

Select Organization.

Expand the hierarchy to select Variable cost.

By default, the variable percentage is 100 percent.

The rules are date-effective, and a user or the system can expire a rule if a newer version is created.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create and assign a cost distribution policy to a cost
control unit
2/18/2021 • 2 minutes to read • Edit Online

Create a policy

Create rules for the policy

Cost distribution rules are used to distribute costs that have been financially counted on a collective cost center.

The cost accountant makes sure that the cost is distributed to the cost centers, based on the selected allocation

base. A policy and the corresponding rules are assigned to a cost control unit. This task guide uses an example

to show how to create a cost distribution policy and the corresponding rules.

1. Go to Cost accounting > Policies > Cost distribution policies.

2. Click New.

3. In the Policy name field, type a value.

4. In the Description field, type a value.

5. In the Cost object dimension hierarchy field, enter or select a value.

6. In the Cost element dimension hierarchy field, enter or select a value.

7. In the Statistical dimension field, enter or select a value.

8. Click Save.

Select Organization.

Select CDS P/L.

Select Statistical elements.

1. Click New.

2. In the list, mark the selected row.

3. In the Cost object dimension hierarchy node field, enter or select a value.

4. In the Cost element dimension hierarchy node field, enter or select a value.

5. In the Cost behavior field, select an option.

6. In the Allocation base field, enter or select a value.

7. Click New.

8. In the list, mark the selected row.

9. In the Cost object dimension hierarchy node field, enter or select a value.

10. In the Cost element dimension hierarchy node field, enter or select a value.

11. In the Cost behavior field, select an option.

12. In the Allocation base field, enter or select a value.

13. Click Save.

Expand the hierarchy to select 094.

Select Other operating expenses and then select 605110 Cleaning.

Select Fixed cost.

Expand the hierarchy to select 094.

Select Other operating expenses and then select 605150 Rent.

Select Fixed cost.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/tasks/create-assign-cost-distribution-policy-cost-control-unit.md


Assign rules to a cost control unit

NOTENOTE

1. Click Policy assignments for cost control unit.

2. Click New.

3. In the list, mark the selected row.

4. In the Valid from accounting date field, enter a date.

5. In the Cost control unit field, enter or select a value.

6. Click Save.

Select September 1 in the valid fiscal year.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a cost rollup policy
2/18/2021 • 2 minutes to read • Edit Online

Create a policy

Create rules for the cost rollup policy

This procedure shows how to create a cost rollup policy and create rules for the policy. The demo data used to

create this procedure is USP2.

1. Go to Cost accounting > Policies > Cost rollup policies.

2. Click New.

3. In the Policy name field, type a value.

4. In the Description field, type a value.

5. In the Cost object dimension hierarchy field, enter or select a value.

6. In the Cost element dimension hierarchy field, enter or select a value.

7. Click Save.

Select Cost rollup CC.

Select Cost rollup CC.

1. Click New.

2. In the list, mark the selected row.

3. In the Cost object dimension hierarchy node field, enter or select a value.

4. In the Cost element dimension hierarchy node field, enter or select a value.

5. In the Secondary cost element field, enter or select a value.

6. Click New.

7. In the list, mark the selected row.

8. In the Cost object dimension hierarchy node field, enter or select a value.

9. In the Cost element dimension hierarchy node field, enter or select a value.

10. In the Secondary cost element field, enter or select a value.

11. Click New.

12. In the list, mark the selected row.

13. In the Cost object dimension hierarchy node field, enter or select a value.

14. In the Cost element dimension hierarchy node field, enter or select a value.

15. In the Secondary cost element field, enter or select a value.

Select 007.

Select Cost rollup CE.

For this example, map the secondary cost element CC-007 to the cost center.

Select 008.

Select Cost rollup CE.

For this example, map the secondary cost element CC-008 to the cost center.

Select 009.

Select Cost rollup CE.

For this example, map the secondary cost element CC-009 to the cost center.

Continue until all cost centers are mapped to their corresponding secondary cost elements.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/tasks/create-cost-rollup-policy.md


NOTENOTE

16. Click Save.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Manage a data source for the cost accounting
ledger
2/18/2021 • 2 minutes to read • Edit Online

NOTENOTE

Use this procedure to manage the general ledger data source for a cost accounting ledger. Before you complete

this task, make sure that you play the "Create a cost accounting ledger" and "Define cost control units" task

guides. This recording uses the USP2 demo data company.

1. Go to Cost accounting > Ledger setup > Cost accounting ledgers.

2. In the list, find and select the desired record.

3. Click Actual versions.

4. On the Action Pane, click Manage.

5. Click General ledger.

6. Click New.

7. In the Name field, type a value.

8. In the Data provider field, enter or select a value.

9. In the Cost element dimension field, enter or select a value.

10. Click Save.

11. Click Configure data provider.

12. In the Legal entity field, enter or select a value.

13. Click New.

14. In the Posting layer field, select Current.

15. Click OK.

For this example, select Dynamics 365 Finance - General ledger entries.

For this example, select Cost elements.

For this example, select USP2.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/tasks/manage-data-source-cost-accounting-ledger.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Process and trace source data
2/18/2021 • 2 minutes to read • Edit Online

NOTENOTE

All data processing is run by jobs. For each job and data provider, a journal is created to document that the

process has been run, and that the entries were processed in the current job. Use this procedure to set up a data

source and then trace the origin of a specific cost entry. This recording uses the USP2 demo data company

USP2. Before you complete this task, make sure that you play the following task guides: "Create a cost

accounting ledger," "Define cost control units," and "Manage data source for the cost accounting ledger."

1. Go to Cost accounting > Ledger setup > Cost accounting ledgers.

2. In the list, find and select the desired record.

3. Click Actual versions.

4. On the Action Pane, click Source data processing.

5. Click General ledger entry transfer journals.

6. In the list, find and select the desired record.

7. Click Journal entries.

8. In the list, mark the selected row.

9. Click Cost entries.

10. Click Source entry.

11. On the Action Pane, click Source data processing.

12. Click General ledger.

13. In the Fiscal calendar period field, enter or select a value.

14. Click OK.

Select the cost accounting ledger that you created earlier.

For this example, select Fiscal 2017 Period 9.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/tasks/process-trace-source-data.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Term definition

Overhead calculation overview

This topic describes the typical processes for calculating and allocating overhead costs.

Overhead costs are the costs that are incurred in order to run a business, but that can't be directly attributed to

any specific business activity, product, or service. Overhead costs provide critical support for the generation of

profit-making activities. Here are some examples of overhead costs:

Rent

Electricity

Administrative salaries

Overhead calculation runs the cost accounting policies in the correct order. You can run overhead calculation

multiple times for the same fiscal period if cost accounting policies have been changed or specific errors have

been detected. Each run of the overhead calculation is stored and receives a unique version ID that lets you

compare the calculations in various versions. The cost entries that the overhead calculation generates receive an

accounting date. This accounting date matches the end date of the fiscal period that is used in the calculation.

The unique version ID consists of the following elements:

Version type

Date and time

Cost accounting ledger

Fiscal year

Fiscal period

Overhead calculation is run independently of the version. Therefore, you can calculate the Budget version before

the Actual version. Overhead calculation consists of four steps, as shown in the following illustration. In each

step, a journal header is created that has journal entries. This journal header keeps the input data for each

calculation step. Policies and rules are applied to each journal line, and cost entries are generated as output.

Therefore, you always have full traceability.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/overhead-calculation.md


Calculate and allocate the Electricity overhead cost

A C C O UN T IN GA C C O UN T IN G
DAT EDAT E C O ST  C EN T ERC O ST  C EN T ER M A IN  A C C O UN TM A IN  A C C O UN T

A M O UN T  IN  T H EA M O UN T  IN  T H E
A C C O UN T IN GA C C O UN T IN G
C URREN C YC URREN C Y

January 3, 2017 CC099 Default cost
center

10001 Electricity 10,000.00

Step 1: Process the cost behavior calculationStep 1: Process the cost behavior calculation

Define the cost behavior ruleDefine the cost behavior rule

In Financial accounting, some costs, such as electricity, are registered as a lump sum. Therefore, detailed

managerial insight isn't provided for Cost accounting. In Cost accounting, to provide correct managerial insight

across all organizational units and levels, costs must flow through the organizational units. This flow must be

based on either an accurate record of the consumption or a fair assessment. In the general ledger, an electricity

cost can be posted as shown in the following table.

By default, when cost entries are imported from the source data, they receive the UnclassifiedUnclassified cost behavior

classification in Cost accounting. By applying cost behavior policy rules, you can reclassify cost entries as either

Fixed costFixed cost or Var iable costVariable cost.

In some cases, part of the cost is a fixed fee, and the remaining cost is based on consumption. Electricity bills

often match this definition. After you pay a specific fixed fee, you pay for consumption per kilowatt hour (Kwh).

For example, if the fixed cost fee is 1,000.00, here is how the cost behavior rule is defined:

file:///T:/eiye/ac1a/dynamics365/finance/cost-accounting/media/period-cost-calculation.png
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00001 Cost behavior
calculation
journal

Fiscal 2017 Period 1 Overhead
calculation / 01-
02-2017
11:51:00 PM /
Ledger /2017 /
Period 1

J o u r n a l  e n t r i e s  (C o st  o b j e c t  b a l a n c e  j o u r n a l  e n t r i e s )J o u r n a l  e n t r i e s  (C o st  o b j e c t  b a l a n c e  j o u r n a l  e n t r i e s )

A C C O UN T INA C C O UN T IN
G DAT EG DAT E C O ST  O B JEC TC O ST  O B JEC T C O ST  EL EM EN TC O ST  EL EM EN T

C O STC O ST
B EH AVIO RB EH AVIO R A M O UN TA M O UN T

January 3,
2017

CC099 Default cost
center

10001 Electricity Unclassified 10,000.00

C o st  e n t r i e sC o st  e n t r i e s

C O ST  O B JEC TC O ST  O B JEC T C O ST  EL EM EN TC O ST  EL EM EN T
C O STC O ST
B EH AVIO RB EH AVIO R A M O UN TA M O UN T

A C C O UN T IN GA C C O UN T IN G
DAT EDAT E

CC099 Default cost
center

10001 Electricity Unclassified 10,000.00 January 3,
2017

CC099 Default cost
center

10001 Electricity Unclassified -10,000.00 January 31,
2017

CC099 Default cost
center

10001 Electricity Fixed cost 1,000.00 January 31,
2017

CC099 Default cost
center

10001 Electricity Variable cost 9,000.00 January 31,
2017

Step 2: Process the cost distribution calculationStep 2: Process the cost distribution calculation

Define the cost distribution ruleDefine the cost distribution rule

C O ST  O B JEC TC O ST  O B JEC T KW HKW H

CC001 HR 1,000

Fixed amount 1,000.00

0 <= 1,000.00 = Fixed

1000,01 < N = Variable

For more information, see Create and assign a cost behavior policy to a cost control unit.

Cost distribution is used to redistribute cost from one cost object to one or more other cost objects by applying

a relevant allocation base. Cost distribution and cost allocation differ in that cost distribution always occurs at

the level of the primary cost element of the original cost.

In Financial accounting, electricity costs are often registered as a lump sum. In Cost accounting, this approach

isn't detailed enough. The variable cost should be distributed to the individual cost objects on a fair basis. The

most logical allocation basis is the consumption of electricity (Kwh). A statistical dimension member that is

named Electricity is created, and electricity consumption is recorded. By default, all statistical dimension

members become available as allocation bases.



CC002 Finance 6,000

CC003 Assembly 0

C O ST  O B JEC TC O ST  O B JEC T KW HKW H

C O ST  O B JEC TC O ST  O B JEC T M A GN IT UDEM A GN IT UDE
A L LO C AT IO NA L LO C AT IO N
FA C TO RFA C TO R A M O UN TA M O UN T

CC001 HR 1,000 (1,000 ÷ 7,000) ×
9,000.00

1,285.71

CC002 Finance 6,000 (6,000 ÷ 7,000) ×
9,000.00

7,714.29

CC003 Assembly 0 (0 ÷ 7,000) ×
9,000.00

0.00

C O ST  O B JEC TC O ST  O B JEC T F O RM UL AF O RM UL A M A GN IT UDEM A GN IT UDE
A L LO C AT IO NA L LO C AT IO N
FA C TO RFA C TO R A M O UN TA M O UN T

CC001 HR (1,000 > 0.00) 1 (1 ÷ 2) ×
1,000.00

500.00

CC002 Finance (6,000 > 0.00) 1 (1 ÷ 2) ×
1,000.00

500.00

CC003 Assembly (0 > 0.00) 0 (0 ÷ 2) ×
1,000.00

0.00

J o u r n a lJ o u r n a l
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00002 Cost distribution
calculation
journal

Fiscal 2017 Period 1 Overhead
calculation / 01-
02-2017
11:51:00 PM /
Ledger /2017 /
Period 1

J o u r n a l  e n t r i e s  (C o st  o b j e c t  b a l a n c e  j o u r n a l  e n t r i e s )J o u r n a l  e n t r i e s  (C o st  o b j e c t  b a l a n c e  j o u r n a l  e n t r i e s )

A C C O UN T INA C C O UN T IN
G DAT EG DAT E C O ST  O B JEC TC O ST  O B JEC T C O ST  EL EM EN TC O ST  EL EM EN T

C O STC O ST
B EH AVIO RB EH AVIO R A M O UN TA M O UN T

January 31,
2017

CC099 Default cost
center

10001 Electricity Fixed cost 1,000.00

The following table shows the result when electricity consumption is applied as an allocation base for variable

costs.

The fixed cost should be distributed evenly to the individual cost objects that have consumed electricity. You can

achieve this result by using the Electricity statistical dimension member in a formula allocation base: (Electricity

> 0.00) The following table shows the result when electricity consumption is applied as an allocation base for

variable costs.



January 31,
2017

CC099 Default cost
center

10001 Electricity Variable cost 9,000.00

A C C O UN T INA C C O UN T IN
G DAT EG DAT E C O ST  O B JEC TC O ST  O B JEC T C O ST  EL EM EN TC O ST  EL EM EN T

C O STC O ST
B EH AVIO RB EH AVIO R A M O UN TA M O UN T

C o st  e n t r i e sC o st  e n t r i e s

C O ST  O B JEC TC O ST  O B JEC T C O ST  EL EM EN TC O ST  EL EM EN T
C O STC O ST
B EH AVIO RB EH AVIO R A M O UN TA M O UN T

A C C O UN T IN GA C C O UN T IN G
DAT EDAT E

CC099 Default cost
center

10001 Electricity Fixed cost -1,000.00 January 31,
2017

CC001 HR 10001 Electricity Fixed cost 500.00 January 31,
2017

CC002 Finance 10001 Electricity Fixed cost 500.00 January 31,
2017

CC099 Default cost
center

10001 Electricity Variable cost -9,000.00 January 31,
2017

CC001 HR 10001 Electricity Variable cost 1,285.71 January 31,
2017

CC002 Finance 10001 Electricity Variable cost 7,714.29 January 31,
2017

Step 3: Process the overhead rate calculationStep 3: Process the overhead rate calculation

Define the overhead rateDefine the overhead rate

C O ST  O B JEC TC O ST  O B JEC T H O URSH O URS

Proj 1 Project 1 3

Proj 2 Project 2 1

C O ST  O B JEC TC O ST  O B JEC T C O ST  EL EM EN TC O ST  EL EM EN T C O ST  B EH AVIO RC O ST  B EH AVIO R UN IT SUN IT S RAT ERAT E

CC001 HR 10001 Variable cost 1 10

For more information, see Create and assign a cost distribution policy to a cost control unit.

The overhead rate is used to charge one or more specific cost objects. The charge is based on a predetermined

cost rate and the magnitude from the assigned allocation base.

Cost object CC001 HR contributes to a set of internal projects. A statistical dimension member that is named HR

projects is created to measure the consumed magnitude.

A predetermined cost rate for the cost projects contribution has been defined.

The following table shows the result when the HR projects are applied as an allocation base.



C O ST  O B JEC TC O ST  O B JEC T M A GN IT UDEM A GN IT UDE C O ST  EL EM EN TC O ST  EL EM EN T
A L LO C AT IO NA L LO C AT IO N
FA C TO RFA C TO R A M O UN TA M O UN T

Proj 1 Project 1 3 10001 (3 ÷ 1) × 10.00 30.00

Proj 2 Project 2 1 10001 (1 ÷ 1) × 10.00 10.00

J o u r n a lJ o u r n a l
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00003 Overhead rate
calculation
journal

Fiscal 2017 Period 1 Overhead
calculation / 01-
02-2017
11:51:00 PM /
Ledger /2017 /
Period 1

J o u r n a l  e n t r i e s  ( J o u r n a l  e n t r i e s  fo r  o v e r h e a d  r a t e  c a l c u l a t i o n )J o u r n a l  e n t r i e s  ( J o u r n a l  e n t r i e s  fo r  o v e r h e a d  r a t e  c a l c u l a t i o n )

A C C O UN T IN G DAT EA C C O UN T IN G DAT E C O ST  O B JEC TC O ST  O B JEC T M A GN IT UDEM A GN IT UDE

January 31, 2017 Proj 1 Internal Proj 1 3.00

January 31, 2017 Proj 2 Internal Proj 2 1.00

C o st  e n t r i e sC o st  e n t r i e s

C O ST  O B JEC TC O ST  O B JEC T C O ST  EL EM EN TC O ST  EL EM EN T
C O STC O ST
B EH AVIO RB EH AVIO R A M O UN TA M O UN T

A C C O UN T IN GA C C O UN T IN G
DAT EDAT E

CC0001 HR 10001 Electricity Variable cost -30.00 January 31,
2017

Proj 1 Internal Proj
1

10001 Electricity Variable cost 30.00 January 31,
2017

CC001 HR 10001 Electricity Variable cost -10.00 January 31,
2017

Proj 2 Internal Proj
2

10001 Electricity Variable cost 10.00 January 31,
2017

Step 4: Process the cost allocation calculationStep 4: Process the cost allocation calculation

For more information, see Perform overhead calculation.

Allocation is used to allocate the balance of a cost object to other cost objects by applying an allocation base.

Finance supports the reciprocal allocation method. In the reciprocal allocation method, the mutual services that

auxiliary cost objects exchange are fully recognized. The system automatically determines the correct order to

perform the allocations in. The balance of a cost object is allocated by a single allocation base. Allocations across

cost objects dimensions and their respective members are supported. The allocation order is controlled by the

cost control unit.



Define the cost allocationDefine the cost allocation

C O ST  O B JEC TC O ST  O B JEC T H R SERVIC ESH R SERVIC ES

CC002 Finance 35

CC003 Assembly 55

CC004 Packaging 10

C O ST  O B JEC TC O ST  O B JEC T F IN A N C E SERVIC ESF IN A N C E SERVIC ES

CC003 Assembly 65

CC004 Packaging 35

C O ST  O B JEC TC O ST  O B JEC T A SSEM B LY  SERVIC ES ( H O URS)A SSEM B LY  SERVIC ES ( H O URS)

Prod 1 Product 1 60

Prod 2 Product 2 20

C O ST  O B JEC TC O ST  O B JEC T PA C KA GIN G SERVIC ES ( H O URS)PA C KA GIN G SERVIC ES ( H O URS)

Prod 1 Product 1 80

Here is a simple example that explains how you can trace the flow of cost. Cost object CC001 HR contributes to

several cost objects. A statistical dimension member that is named HR services is created to measure the

consumed magnitude.

Cost object CC002 Finance contributes to several cost objects. A statistical dimension member that is named

Finance services is created to measure the consumed magnitude.

Cost object CC003 Assembly contributes to several cost objects. A statistical dimension member that is named

Assembly services is created to measure the consumed magnitude.

Cost object CC004 Packaging contributes to several cost objects. A statistical dimension member that is named

Packaging services is created to measure the consumed magnitude.

file:///T:/eiye/ac1a/dynamics365/finance/cost-accounting/media/reciprocal-method.png


Prod 2 Product 2 15

C O ST  O B JEC TC O ST  O B JEC T PA C KA GIN G SERVIC ES ( H O URS)PA C KA GIN G SERVIC ES ( H O URS)

NOTENOTE

C O ST  O B JEC TC O ST  O B JEC T M A GN IT UDEM A GN IT UDE
A L LO C AT IO NA L LO C AT IO N
FA C TO RFA C TO R A M O UN TA M O UN T C O ST  B EH AVIO RC O ST  B EH AVIO R

CC002 Finance 35 (35 ÷ 100) ×
500.00

175.00 Fixed cost

CC003 Assembly 55 (55 ÷ 100) ×
500.00

275.00 Fixed cost

CC004 Packaging 10 (10 ÷ 100) ×
500.00

50.00 Fixed cost

CC002 Finance 35 (35 ÷ 100) ×
1,245.71

436.00 Variable cost

CC003 Assembly 55 (55 ÷ 100) ×
1,245.71

685.14 Variable cost

CC004 Packaging 10 (10 ÷ 100) ×
1,245.71

124.57 Variable cost

C O ST  O B JEC TC O ST  O B JEC T M A GN IT UDEM A GN IT UDE
A L LO C AT IO NA L LO C AT IO N
FA C TO RFA C TO R A M O UN TA M O UN T C O ST  B EH AVIO RC O ST  B EH AVIO R

CC003 Assembly 65 (65 ÷ 100) ×
(500.00 +
175.00)

438.75 Fixed cost

CC004 Packaging 35 (35 ÷ 100) ×
(500.00 +
175.00)

236.25 Fixed cost

CC003 Assembly 65 (65 ÷ 100) ×
(7,714.29 +
436.00)

5,297.69 Variable cost

CC004 Packaging 35 (35 ÷ 100) ×
(7,714.29 +
436.00)

2,852.60 Variable cost

Statistical measures such as the production hours that a product consumes can be derived from source data. For more

information, see Statistical measure provider template. The following table shows the result when the HR services are

applied as an allocation base for total cost (fixed cost and variable cost).

The following table shows the result when the Finance services are applied as an allocation base for total cost

(fixed cost and variable cost).

The following table shows the result when the Assembly services are applied as an allocation base for total cost

(fixed cost and variable cost).



C O ST  O B JEC TC O ST  O B JEC T M A GN IT UDEM A GN IT UDE
A L LO C AT IO NA L LO C AT IO N
FA C TO RFA C TO R A M O UN TA M O UN T C O ST  B EH AVIO RC O ST  B EH AVIO R

Prod 1 Product 1 60 (60 ÷ 80) ×
(275.00 +
438.75)

535.31 Fixed cost

Prod 2 Product 2 20 (20 ÷ 80) ×
(275.00 +
438.75)

178.44 Fixed cost

Prod 1 Product 1 60 (60 ÷ 80) ×
(5,297.69 +
685.14)

4,487.12 Variable cost

Prod 2 Product 2 20 (20 ÷ 80) ×
(5,297.69 +
685.14)

1,495.71 Variable cost

C O ST  O B JEC TC O ST  O B JEC T M A GN IT UDEM A GN IT UDE
A L LO C AT IO NA L LO C AT IO N
FA C TO RFA C TO R A M O UN TA M O UN T C O ST  B EH AVIO RC O ST  B EH AVIO R

Prod 1 Product 1 80 (80 ÷ 95) ×
(50.00 + 236.25)

241.05 Fixed cost

Prod 2 Product 2 15 (15 ÷ 95) ×
(50.00 + 236.25)

45.20 Fixed cost

Prod 1 Product 1 80 (80 ÷ 95) ×
(2,852.60 +
124.57)

2,507.09 Variable cost

Prod 2 Product 2 15 (15 ÷ 95) ×
(2,852.60 +
124.57)

470.08 Variable cost

J o u r n a l  e n t r i e s  (c o s t  o b j e c t  b a l a n c e  j o u r n a l  e n t r i e s )J o u r n a l  e n t r i e s  (c o s t  o b j e c t  b a l a n c e  j o u r n a l  e n t r i e s )
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00004 Cost allocation
journal

Fiscal 2017 Period 1 Overhead
calculation / 01-
02-2017
11:51:00 PM /
Ledger /2017 /
Period 1

J o u r n a l  l i n e sJ o u r n a l  l i n e s

A C C O UN T INA C C O UN T IN
G DAT EG DAT E C O ST  O B JEC TC O ST  O B JEC T C O ST  EL EM EN TC O ST  EL EM EN T

C O STC O ST
B EH AVIO RB EH AVIO R A M O UN TA M O UN T

January 31,
2017

CC001 HR 10001 Electricity Fixed cost 500.00

The following table shows the result when the Packaging services are applied as an allocation base for total cost

(fixed cost and variable cost).



January 31,
2017

CC001 HR 10001 Electricity Variable cost 1,245.71

January 31,
2017

CC002 Finance 10001 Electricity Fixed cost 675.00

January 31,
2017

CC002 Finance 10001 Electricity Variable cost 8,150.29

January 31,
2017

CC003 Assembly 10001 Electricity Fixed cost 713.75

January 31,
2017

CC003 Assembly 10001 Electricity Variable cost 5,982.83

January 31,
2017

CC003 Packaging 10001 Electricity Fixed cost 286.25

January 31,
2017

CC003 Packaging 10001 Electricity Variable cost 2,977.17

January 31,
2017

Prod 1 Product 1 10001 Electricity Fixed cost 776.36

January 31,
2017

Prod 1 Product 1 10001 Electricity Variable cost 6,994.21

January 31,
2017

Prod 2 Product 1 10001 Electricity Fixed cost 223.64

January 31,
2017

Prod 2 Product 1 10001 Electricity Variable cost 1,965.79

A C C O UN T INA C C O UN T IN
G DAT EG DAT E C O ST  O B JEC TC O ST  O B JEC T C O ST  EL EM EN TC O ST  EL EM EN T

C O STC O ST
B EH AVIO RB EH AVIO R A M O UN TA M O UN T

C o st  e n t r i e sC o st  e n t r i e s

C O ST  O B JEC TC O ST  O B JEC T C O ST  EL EM EN TC O ST  EL EM EN T
C O STC O ST
B EH AVIO RB EH AVIO R A M O UN TA M O UN T

A C C O UN T IN GA C C O UN T IN G
DAT EDAT E

CC001 HR 10001 Electricity Fixed cost -500.00 January 31,
2017

CC002 Finance 10001 Electricity Fixed cost 175.00 January 31,
2017

CC003 Assembly 10001 Electricity Fixed cost 275.00 January 31,
2017

CC004 Packaging 10001 Electricity Fixed cost 50,00 January 31,
2017

CC001 HR 10001 Electricity Variable cost -1,245.71 January 31,
2017



CC002 Finance 10001 Electricity Variable cost 436.00 January 31,
2017

CC003 Assembly 10001 Electricity Variable cost 685.14 January 31,
2017

CC004 Packaging 10001 Electricity Variable cost 124.57 January 31,
2017

CC002 Finance 10001 Electricity Fixed cost -675.00 January 31,
2017

CC003 Assembly 10001 Electricity Fixed cost 438.75 January 31,
2017

CC004 Packaging 10001 Electricity Fixed cost 236.25 January 31,
2017

CC002 Finance 10001 Electricity Variable cost -8,150.29 January 31,
2017

CC003 Assembly 10001 Electricity Variable cost 5,297.69 January 31,
2017

CC004 Packaging 10001 Electricity Variable cost 2,852.60 January 31,
2017

CC003 Assembly 10001 Electricity Fixed cost -713.75 January 31,
2017

Prod 1 Product 1 10001 Electricity Fixed cost 535.31 January 31,
2017

Prod 2 Product 2 10001 Electricity Fixed cost 178.44 January 31,
2017

CC003 Assembly 10001 Electricity Variable cost -5,982.83 January 31,
2017

Prod 1 Product 1 10001 Electricity Variable cost 4,487.12 January 31,
2017

Prod 2 Product 2 10001 Electricity Variable cost 1,495.71 January 31,
2017

CC003 Assembly 10001 Electricity Fixed cost -286.25 January 31,
2017

Prod 1 Product 1 10001 Electricity Fixed cost 241.05 January 31,
2017

Prod 2 Product 2 10001 Electricity Fixed cost 45.20 January 31,
2017

C O ST  O B JEC TC O ST  O B JEC T C O ST  EL EM EN TC O ST  EL EM EN T
C O STC O ST
B EH AVIO RB EH AVIO R A M O UN TA M O UN T

A C C O UN T IN GA C C O UN T IN G
DAT EDAT E



CC003 Assembly 10001 Electricity Variable cost -2,977.17 January 31,
2017

Prod 1 Product 1 10001 Electricity Variable cost 2,507.09 January 31,
2017

Prod 2 Product 2 10001 Electricity Variable cost 470.08 January 31,
2017

C O ST  O B JEC TC O ST  O B JEC T C O ST  EL EM EN TC O ST  EL EM EN T
C O STC O ST
B EH AVIO RB EH AVIO R A M O UN TA M O UN T

A C C O UN T IN GA C C O UN T IN G
DAT EDAT E

Conclusion

C O ST  EL EM EN TC O ST  EL EM EN T

C O ST  O B JEC TC O ST  O B JEC T

TOTA LTOTA L
C C 09C C 09
99

C C 00C C 00
11 C C 002C C 002 C C 003C C 003 C C 004C C 004

P RO JP RO J
11

P RO JP RO J
22

P RO DP RO D
11

P RO DP RO D
22

10001 Electricity 0.000.00 0.000.00 0.000.00 0.000.00 30.030.0
00

10.010.0
00

7,777,77
0.570.57

2,182,18
9.439.43

10,010,0
00.000.0
00

Uncla
ssified

0.00

Fixed
cost

0.00 0.00 0.00 0.00 0.00 776.3
6

223.6
4

1,001,00
0.000.00

Variab
le
cost

000 0.00 0.00 0.00 0.00 30.00 10.00 6,994.
21

1,965.
79

9,009,00
0.000.00

NOTENOTE

NOTENOTE

In Financial accounting, a cost of 10,000.00 for Electricity is posted to a dummy cost center ID. Therefore, cost

accountants will know that this cost must be allocated. In Cost accounting, the costs flow across organizational

units and levels, based on the policies and rules that are applied. Each cost has been associated with an

allocation base that provides the best assessment for the allocation of costs.

This topic shows how a primary cost element, 10001 Electricity, flows through the cost objects. Therefore, this overhead

cost is allocated to the lowest level in the organization. In other words, the cost objects at the lowest level bear the cost. If

you require a visual flow of the cost between the cost objects, you can use the cost roll-up policy rules to visualize the

flow of the cost. For more information, see Cost rollup policy and overhead calculation.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

Example of cost rollup policy setup

C O ST  C EN T ERSC O ST  C EN T ERS DESC RIP T IO NDESC RIP T IO N

CC001 HR

CC002 Finance

CC003 Assembly

CC004 Packaging

Cost accounting lets you gain insight into how the cost flow relates to the products and services that are

delivered within an organization. To see the cost transparency, it's crucial to achieve cost allocation between cost

objects based on an appropriate allocation basis. By default, the cost allocation is achieved for the primary cost

element, which is desired in some situations, but it has a few implications that should be considered.

Auxiliary cost objects will end with a zero balance for the primary cost element after overhead

calculation.

The volume of cost entries generated by overhead calculation can be very high.

It is not possible to track the cost flow between cost objects.

To avoid these implications, Cost accounting lets you configure cost allocation to fit into your organization

managerial reporting requirements. This topic discusses how you can determine the correct level of secondary

cost elements and create cost rollup rules that fit into organization reporting and cost traceability.

You can change configurations if reporting requirements change.

Imagine that an organization has the following structure with 4 cost centers.

Cost object dimensionCost object dimension

Cost element dimensionCost element dimension

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/cost-rollup.md


C O ST  EL EM EN T SC O ST  EL EM EN T S DESC RIP T IO NDESC RIP T IO N T Y P ET Y P E

1001 Electricity Primary

1002 Salaries Primary

1003 Advertising Primary

DIM EN SIO N  H IERA RC H YDIM EN SIO N  H IERA RC H Y
N A M EN A M E DIM EN SIO NDIM EN SIO N

DIM EN SIO N  H IERA RC H YDIM EN SIO N  H IERA RC H Y
T Y P E N A M ET Y P E N A M E A C C ESS L IST  H IERA RC H YA C C ESS L IST  H IERA RC H Y

Organization Cost centers Dimension classification
hierarchy

No

  DIM EN SIO N  M EM B ER RA N GESDIM EN SIO N  M EM B ER RA N GES   

NodesNodes From dimension memberFrom dimension member To dimension memberTo dimension member

Organization

  Admin

    Finance CC001 CC001

    HR CC002 CC002

  Production

    Packaging CC003 CC003

    Assembly CC004 CC004

DIM EN SIO N  H IERA RC H Y  N A M EDIM EN SIO N  H IERA RC H Y  N A M E DIM EN SIO NDIM EN SIO N DIM EN SIO N  H IERA RC H Y  T Y P E  N A M EDIM EN SIO N  H IERA RC H Y  T Y P E  N A M E

Profit & Loss statement Cost elements Dimension classification hierarchy

  DIM EN SIO N  M EM B ER RA N GESDIM EN SIO N  M EM B ER RA N GES   

Nodes From dimension member To dimension member

Profit & Loss statement

A dimension hierarchy that fulfills the organizational reporting requirements can be set up as follows.

Dimension hierarchy detailsDimension hierarchy details

Dimension hierarchyDimension hierarchy

A dimension hierarchy that fulfills the policy requirement can be set up as follows.

Dimension hierarchy detailsDimension hierarchy details

Dimension hierarchyDimension hierarchy



    Primary cost 10001 10003

  DIM EN SIO N  M EM B ER RA N GESDIM EN SIO N  M EM B ER RA N GES   

  C O ST  O B JEC TC O ST  O B JEC T       TOTA LTOTA L

Cost elementCost element CC001CC001 CC002CC002 CC003CC003 CC004CC004

10011001
ElectricityElectricity

100,00 200,00 6.000,00 2.000,00 8.300,008.300,00

1002 Salaries1002 Salaries 10.000,00 10.000,00 8.000,00 6.500,00 34.500,0034.500,00

10031003
Adver tisingAdver tising

0,00 4.000,00 0,00 0,00 4.000,004.000,00

10.100,00 14.200,00 14.000,00 8.500,00 46.800,0046.800,00

STAT IST IC A L  EL EM EN T SSTAT IST IC A L  EL EM EN T S DESC RIP T IO NDESC RIP T IO N

SE-1 HR services

SE-2 Finance services

C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N H R SERVIC ESH R SERVIC ES

CC002 Finance 35

CC003 Assembly 55

CC004 Packaging 10

C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N F IN A N C E SERVIC ESF IN A N C E SERVIC ES

CC003 Assembly 65

CC004 Packaging 35

After the general ledger entries are processed, the cost entry balance by cost object looks like this.

Statistical dimensionStatistical dimension

Cost object CC001 HR is contributing HR services to several cost objects.

HR services are consumed by the following distribution of magnitude.

Cost object CC002 Finance is contributing to several cost objects.

Finance services are consumed by the following distribution of magnitude.

Cost allocation polices can be set up as follows.



P O L IC Y  N A M EP O L IC Y  N A M E DESC RIP T IO NDESC RIP T IO N

C O ST  O B JEC TC O ST  O B JEC T
DIM EN SIO NDIM EN SIO N
H IERA RC H YH IERA RC H Y

STAT IST IC A LSTAT IST IC A L
DIM EN SIO NDIM EN SIO N

C O ST  EL EM EN TC O ST  EL EM EN T
DIM EN SIO NDIM EN SIO N

2017 Cost allocation Organization Statistical elements Cost elements

C O ST  O B JEC T  DIM EN SIO NC O ST  O B JEC T  DIM EN SIO N
H IERA RC H Y  N O DEH IERA RC H Y  N O DE C O ST  B EH AVIO RC O ST  B EH AVIO R A L LO C AT IO N  B A SEA L LO C AT IO N  B A SE

CC001 Total HR ser vicesHR ser vices

CC002 Total Financial ser vicesFinancial ser vices

How cost flows between cost centers

C O ST  EL EM EN T SC O ST  EL EM EN T S T Y P ET Y P E   

1001 Electricity Primary

1002 Salaries Primary

1003 Advertising Primary

SC-CC001SC-CC001 HRHR Secondar ySecondar y

SC-CC002SC-CC002 FinanceFinance Secondar ySecondar y

SC-CC003SC-CC003 AssemblyAssembly Secondar ySecondar y

SC-CC004SC-CC004 PackagingPackaging Secondar ySecondar y

DIM EN SIO N  H IERA RC H Y  N A M EDIM EN SIO N  H IERA RC H Y  N A M E DIM EN SIO NDIM EN SIO N DIM EN SIO N  H IERA RC H Y  T Y P E  N A M EDIM EN SIO N  H IERA RC H Y  T Y P E  N A M E

Profit & Loss statement Cost elements Dimension classification hierarchy

  DIM EN SIO N  M EM B ER RA N GESDIM EN SIO N  M EM B ER RA N GES   

Nodes From dimension member To dimension member

Cost allocation rules can be set up as follows.

If you want to learn how cost flows between the cost centers in the organization, you can create cost elements of

the type Secondar ySecondar y  for each cost center. These cost elements will then be used to transfer balances between

the cost centers during the overhead calculation.

Cost element dimension members can be set up as follows.

The dimension hierarchy Profit & Loss statementProfit & Loss statement needs to be updated with the new dimension members so

that the dimension hierarchy contains the correct data that can be used for defining reporting and policies.

Dimension hierarchy detailsDimension hierarchy details

Dimension hierarchyDimension hierarchy



  

Profit & Loss statement

    Primary cost 10001 10003

    Secondary cost SC-CC001SC-CC001 SC-CC004SC-CC004

  DIM EN SIO N  M EM B ER RA N GESDIM EN SIO N  M EM B ER RA N GES   

P O L IC Y  N A M EP O L IC Y  N A M E DESC RIP T IO NDESC RIP T IO N
C O ST  O B JEC T  DIM EN SIO NC O ST  O B JEC T  DIM EN SIO N
H IERA RC H YH IERA RC H Y

C O ST  EL EM EN TC O ST  EL EM EN T
DIM EN SIO N  H IERA RC H YDIM EN SIO N  H IERA RC H Y

2017 Cost flow Organization Profit & Loss statement

C O ST  O B JEC T  DIM EN SIO NC O ST  O B JEC T  DIM EN SIO N
H IERA RC H Y  N O DEH IERA RC H Y  N O DE

C O ST  EL EM EN T  DIM EN SIO NC O ST  EL EM EN T  DIM EN SIO N
H IERA RC H Y  N O DEH IERA RC H Y  N O DE SEC O N DA RY  C O ST  EL EM EN TSEC O N DA RY  C O ST  EL EM EN T

CC001 Profit & Loss statement SC-CC001SC-CC001

CC002 Profit & Loss statement SC-CC002SC-CC002

CC003 Profit & Loss statement SC-CC003SC-CC003

CC004 Profit & Loss statement SC-CC004SC-CC004

Perform overhead calculation

JO URN A LJO URN A L JO URN A L  T Y P EJO URN A L  T Y P E

F ISC A LF ISC A L
C A L EN DA RC A L EN DA R
P ERIO DP ERIO D Y EA RY EA R P ERIO DP ERIO D VERSIO NVERSIO N

00002 Cost allocation
journal

Fiscal 2017 Period 1 Overhead
calculation / 01-
02-2017
11:51:00 PM /
Ledger /2017 /
Period 1

A C C O UN T IN GA C C O UN T IN G
DAT EDAT E C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N C O ST  EL EM EN TC O ST  EL EM EN T DESC RIP T IO NDESC RIP T IO N A M O UN TA M O UN T

31-01-2017 CC001 HR SC-CC001 HR 10.100,00

31-01-2017 CC002 Finance SC-CC002 Finance 17.735,00

Create a Cost rollup policyCost rollup policy  where each cost center is mapped to a corresponding cost element of the type

Secondar ySecondar y .

Cost rollup policesCost rollup polices

Cost rollup rulesCost rollup rules

JournalJournal

The system will now apply the Cost rollup policyCost rollup policy  when it creates the Cost object balance journal entr iesCost object balance journal entr ies .

Cost object balance journal entr iesCost object balance journal entr ies



31-01-2017 CC003 Assembly SC-CC003 Assembly 31.082,75

31-01-2017 CC004 Packaging SC-CC004 Packaging 15.717,25

A C C O UN T IN GA C C O UN T IN G
DAT EDAT E C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N C O ST  EL EM EN TC O ST  EL EM EN T DESC RIP T IO NDESC RIP T IO N A M O UN TA M O UN T

NOTENOTE

C O ST  EL EM EN T  DIM EN SIO N  M EM B ERC O ST  EL EM EN T  DIM EN SIO N  M EM B ER DESC RIP T IO NDESC RIP T IO N A M O UN TA M O UN T

1001 Electricity 200,00

1002 Salaries 10.000,00

1003 Advertising 4.000,00

SC-CC001 HR 3.535,00

C O ST  O B JEC TC O ST  O B JEC T DESC RIP T IO NDESC RIP T IO N C O ST  EL EM EN TC O ST  EL EM EN T DESC RIP T IO NDESC RIP T IO N A M O UN TA M O UN T
A C C O UN T IN GA C C O UN T IN G
DAT EDAT E

CC001 HR SC-CC001 HR -10.100,00 31-01-2017

CC002 Finance SC-CC001 HR 3.535,00 31-01-2017

CC003 Assembly SC-CC001 HR 5.555,00 31-01-2017

CC004 Packaging SC-CC001 HR 1.010,00 31-01-2017

CC002 Finance SC-CC002 Finance -17.735,00 31-01-2017

CC003 Assembly SC-CC002 Finance 11.527,75 31-01-2017

CC004 Packaging SC-CC002 Finance 6.207,25 31-01-2017

View reporting in Excel

The journal entries are created based on the rules in the Cost rollup policyCost rollup policy  if a policy exists. The balance displayed is the

balance of the overhead calculation.

The Cost object cost balance journal entr y detailsCost object cost balance journal entr y details  page that is accessed from the journal entries displays

how the balance is obtained.

Example: The journal entr y for Cost object CC002 FinanceExample: The journal entr y for Cost object CC002 Finance

Cost object cost balance journal entr y detailsCost object cost balance journal entr y details

Cost entr ies generated by the Overhead calculationCost entr ies generated by the Overhead calculation

After the Overhead calculationOverhead calculation is completed, you can report the results using tools such as Microsoft

SharePoint Workspace, Excel, or Power BI.

The dimension hierarchies allow you to view data at different aggregation levels.



P RO F IT  &  LO SSP RO F IT  &  LO SS
STAT EM EN TSTAT EM EN T C O ST  O B JEC TC O ST  O B JEC T       TOTA LTOTA L

CC001CC001 CC002CC002 CC003CC003 CC004CC004

Primar y costPrimar y cost 10.100,0010.100,00 14.200,0014.200,00 14.000,0014.000,00 8.500,008.500,00 46.800,0046.800,00

    1001 100,00 200,00 6.000,00 2.000,00 8.300,008.300,00

    1002 10.000,00 10.000,00 8.000,00 6.500,00 34.500,0034.500,00

    1003 0,00 4.000,00 0,00 0,00 4.000,004.000,00

Secondar ySecondar y
costcost

-10.100,00-10.100,00 -14.200,00-14.200,00 17.082.7517.082.75 7.217,257.217,25 0,000,00

    SC-CC001 -10.100,00 3.535,00 5.555,00 1.010,00 0,000,00

    SC-CC002 0,00 -17.735,00 11.527,75 6.207,25 0,000,00

    SC-CC003 0,00 0,00 0,00 0,00 0,00

    SC-CC004 0,00 0,00 0,00 0,00 0,00

TotalTotal 0,000,00 0,000,00 31.082,7531.082,75 15.717,2515.717,25 46.800,0046.800,00

P RO F IT  &  LO SSP RO F IT  &  LO SS
STAT EM EN TSTAT EM EN T C O ST  O B JEC TC O ST  O B JEC T       TOTA LTOTA L

CC001CC001 CC002CC002 CC003CC003 CC004CC004

Primar y costPrimar y cost 0,000,00 0,000,00 31.082,7531.082,75 15.717,2515.717,25 46.800,0046.800,00

    1001 0,00 0,00 6.207,75 2.092,25 8.300,008.300,00

    1002 0,00 0,00 22.275,00 12.225,00 34.500,0034.500,00

    1003 0,00 0,00 2600,00 1.400,00 4.000,004.000,00

Secondar ySecondar y
costcost

0,000,00 0,000,00 0,000,00 0,000,00 0,000,00

     SC-CC001 0,00 0,00 0,00 0,00 0,000,00

     SC-CC002 0,00 0,00 0,00 0,00 0,000,00

Here is an example of a Power Pivot reporting in Excel.

Using Cost rollup policyCost rollup policy  and Cost elements of the type secondar yCost elements of the type secondar y  allows you to leave the primary cost

per cost object for internal reporting as the primary cost that remains after Overhead calculationOverhead calculation.

If the same example had been performed without creating the Cost rollup policy,Cost rollup policy, the reporting result would

be as shown below. The cost flows correctly but the traceability and insight into how cost flows between the cost

centers are lost.



     SC-CC003 0,00 0,00 0,00 0,00 0,00

     SC-CC004 0,00 0,00 0,00 0,00 0,00

TotalTotal 0,000,00 0,000,00 31.082,7531.082,75 15.717,2515.717,25 46.800,0046.800,00

P RO F IT  &  LO SSP RO F IT  &  LO SS
STAT EM EN TSTAT EM EN T C O ST  O B JEC TC O ST  O B JEC T       TOTA LTOTA L

Additional resources

NOTENOTE

Depending on the reporting and traceability requirements in your organization, you can determine the correct

level of secondary cost elements and create cost rollup rules that fit your needs.

The clear separation between Cost allocationCost allocation and Cost rollup policiesCost rollup policies  provides the flexibility to make

continuous updates without affecting each other.

Cost object dimensions

Cost element dimensions

Dimension hierarchy

Overhead calculation

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Cost control workspace configuration

GeneralGeneral

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Name Enter a unique name for the layout.

Description Enter a detailed description.

Published If you set this field to YesYes , a user who is assigned one of the
following roles can see the report in the Cost controlCost control
workspace:

If you set this field to NoNo, only users who are assigned one
of the following roles can see the report in the CostCost
controlcontrol workspace:

Data filteringData filtering

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Cost accounting ledger The Cost accounting ledgerCost accounting ledger  that the report is based on.
The value is derived from the Cost control unitCost control unit  field.

The Cost controlCost control  workspace is a central point where managers who are responsible for controlling a cost

object or a set of cost objects within a dimension or across dimensions (for example, cost centers and product

groups) can access reports. The reports in the workspace are fully managed by cost accountants, so that the

layout and data that are used for reporting can be consistent across the whole organization.

Cost accountants can define as many report configurations as they require for the desired data composition or

layout. A report configuration consists of six sections, each of which contributes to either the selection of the

targeted data composition or the layout.

To configure a cost control workspace, click Cost accountingCost accounting > SetupSetup > Cost control workspaceCost control workspace

configurationconfiguration.

On the GeneralGeneral  FastTab, you can create a unique report layout. The name of the report will be a unique

identifier that users will be able to recognize in the Cost controlCost control  workspace. You can also specify whether the

report should be shared or kept internal for cost accountants.

Cost accounting manager

Cost accountant

Cost accountant clerk

Cost object controller

Cost accounting manager

Cost accountant

Cost accountant clerk

On the Data filter ingData filter ing FastTab, you define the data foundation for the report. Users of this report will see values

on the report after source data has been processed.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/cost-control-workspace.md


Cost control unit The value that you select determines the cost accounting
ledger and cost objects that this report will be based on.

Statistical dimension hierarchy, Cost element dimension
hierarchy

A Cost controlCost control workspace configuration record can report
either non-monetary or monetary values, but not in the
same layout. Select a value in the Cost elementCost element
dimension hierarchydimension hierarchy  field to report monetary values.
Select a value in the Statistical dimension hierarchyStatistical dimension hierarchy  field
to report non-monetary values. The dimension hierarchy
record that you select determines the structure of the
reporting and aggregation levels.

[!NOTE]
To view non-monetary and monetary values side by
side, you can export data to Microsoft Excel for the
Microsoft Power BI content pack.

Cost object dimension hierarchy Select the dimension hierarchy of the cost object dimension
that suits the purpose of the reporting that you're defining.

Budget original version Select the budget version ID that acts as the original budget
in the context of this report.

Budget revised version Select the budget version ID that acts as the revised budget
in the context of this report.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Assign calculation recordsAssign calculation records

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Fiscal calendar period Select the fiscal calendar period to assign an overhead
calculation ID to.

[!NOTE]
The fiscal periods that are listed in the field come from
the fiscal calendar that is associated with the cost
accounting ledger.

Actual version Select the appropriate overhead calculation ID.

Budget version Select the appropriate overhead calculation ID.

Revised budget version Select the appropriate overhead calculation ID.

Fiscal periods per columnFiscal periods per column

The overhead calculation performs several calculation steps on the source data, such as cost behavior

classification, cost distribution, and cost allocation. Multiple overhead calculations can be done for the same

fiscal period, in case missing source data is discovered or rules must be updated. Each overhead calculation is

saved with a unique ID. The cost accountant can select a specific overhead calculation ID. Users of the report,

such as managers, will see the results of the overhead calculation in the Cost controlCost control  workspace.

On the Fiscal per iods per columnFiscal per iods per column FastTab, the cost accountant decides which fiscal period should be shown

in the report layout.



F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Current period The balance of the current fiscal period is shown.

[!NOTE]
By default, the current period is determined by the
session date. In the Cost controlCost control workspace, a specific
fiscal period can be selected. The selected value then
represents the current period.

Previous period The balance of the previous fiscal period is shown. The
following formula is used:
Current fiscal period – 1

[!NOTE]
By default, the previous period is derived from the
session date. In the Cost controlCost control workspace, a specific
fiscal period can be selected as the current period.
Previous periodPrevious period will then be recalculated accordingly.

Year to date The for the year to date is shown. The following formula is
used:
YearToDate (Current fiscal period)

[!NOTE]
By default, the current period is determined by the
session date. In the Cost controlCost control workspace, a specific
fiscal period can be selected. The selected value then
represents the current period, and the Year to dateYear to date
value will be updated accordingly.

The values in the selected columns will be multiplied by the selected values on the Fiscal per iods per columnFiscal per iods per column

FastTab.



Year to date average The average for the year to date is shown. The following
formula is used:
(YearToDate [Current fiscal period]) ÷ (Count [Current fiscal
period])

In this case, Year to date averageYear to date average = (10 + 10 + 12) ÷ 3 =
10.67

[!NOTE]
By default, the current period is determined by the
session date. In the Cost controlCost control workspace, a specific
fiscal period can be selected. The selected value then
represents the current period, and the Year to dateYear to date
and Year to date averageYear to date average values will be updated
accordingly.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Columns to display for costsColumns to display for costs

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Fixed cost This column type shows the fixed cost, based on the selected
overhead calculation ID.

[!NOTE]
This column type will show a balance only when an
overhead calculation ID is selected for the fiscal period.

Variable cost This column type shows the variable cost, based on the
selected overhead calculation ID.

[!NOTE]
This column type will show a balance only when an
overhead calculation ID is selected for the fiscal period.

Fixed + variable cost This column type shows the fixed cost and variable cost,
based on the selected overhead calculation ID.

[!NOTE]
This column type will show a balance only when an
overhead calculation ID is selected for the fiscal period.

ExampleExample

Statistical dimension member :Statistical dimension member :  Full time
employees

Current date:Current date:  3-21-2017

Period:Period:  Fiscal period 1, Fiscal period 2, Fiscal period 3

Magnitude:Magnitude:  10, 10, 12

The Year to date averageYear to date average value can be calculated for
cost element dimension members and statistical
dimension members.

On the Columns to display for costsColumns to display for costs  FastTab, the cost accountant decides which columns the report layout

should contain. There are three categories: Fixed cost, Variable cost, and Unclassified cost.



Total cost This column type shows the total cost (unclassified cost, fixed
cost, and variable cost).

[!NOTE]
The column type will show the balance at all times.

Unclassified cost This column type shows the unclassified cost.

[!NOTE]
This column can be used to validate whether all costs
have been correctly classified by the overhead
calculation, or whether the cost behavior rules must be
adjusted.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Columns to display for budgeted costsColumns to display for budgeted costs

NOTENOTE

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Budget Budget balances will be shown per the selected columns.

[!NOTE]
The balances will be based on the budget versions that
are selected on the Data filteringData filtering FastTab.

Budget variance Calculate and show the difference between budget and
actual. The following formula is used:
Budget balance – Actual balance

Budget variance in % Calculate and show the difference in percentage between
budget and actual. The following formula is used:
(Budget balance – Actual balance) ÷ Budget balance

Variance period threshold Set a threshold for the variance in monetary amount for the
current period. If the threshold is exceeded, the line will be
highlighted in red in the Cost controlCost control workspace.

[!NOTE]
This field applies only to the cost elements that
represent expenditures.

On the Columns to display for budgeted costsColumns to display for budgeted costs  FastTab, the cost accountant decides which columns should

be shown for the selected budget versions. Individual selections can be made for the original and revised

budget.

Because the following fields behave in the same manner for original budget and revised budget, they will be explained

only one time.



Variance year threshold Set a threshold for the variance in monetary amount for the
year. If the threshold is exceeded, the line will be highlighted
in red in the Cost controlCost control workspace.

Variance threshold % Set a threshold for the variance in percentage. If the
threshold is exceeded, the line will be highlighted in red in
the Cost controlCost control workspace.

[!NOTE]
The same percentage threshold applies to the current
period and year.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Cost control workspace

Add or remove columnsAdd or remove columns

View detailsView details

The Cost controlCost control  workspace is designed as a web report. Therefore, all managers who are responsible for a

cost object can be granted access as described in Define access rights for cost object controllers.

The list of reports that are available for users, such as managers, is controlled by the setting of the PublishedPublished

option on the Cost control workspace configurationsCost control workspace configurations  page.

A manager can select the fiscal calendar period to view. The session date is used to determine the default current

period.

The values in the fiscal calendar period are determined by the report name and the fiscal calendar that is

selected for the cost accounting ledger that is associated with the report name on the Cost control workspaceCost control workspace

configurationsconfigurations  page.

In the cost object dimension hierarchy, users can select the aggregation level at which balances should be

shown. By enabling access-level security, you control the permissions, so that users can select only the hierarchy

levels that they have been granted access to. Therefore, they can see only the aggregated balances that they

have been granted access to.

Users can customize the columns on a report to fit their requirements.

Users can drill into the details behind the balances that are shown in the workspace. If users select a cost

element dimension hierarchy node, and then click View detailsView details , the Cost element detailsCost element details  dialog box shows

detailed information for the node.

A grid shows each cost element that is associated with the cost element dimension hierarchy node, and its



values. The columns that appear in the grid match the workspace settings.

Two charts show a summary of actual versus budget and budget variance by period.

Users can click Cost entr iesCost entr ies  to drill down into the entry details as required.

For example, rent is an expenditure that is distributed to cost centers. A user who wants to understand the rent

cost that their cost center must carry can drill down to see how rent has been calculated.

If users click Allocation baseAllocation base on the Cost entr iesCost entr ies  page, a dialog box appears. Users can then assign the

allocation base to the rule and view the corresponding statistical measures that are registered for the period.

In the following example, the allocation base is of the Formula allocation baseFormula allocation base type, and the formula is

shown. The factors that define the formula are listed. Additionally, a grid shows the calculation that is done per

cost object.

Additional resources

Define access rights for cost object controllers
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Use this procedure to configure the Cost control workspace so that managers at various levels in an

organization can gain insight into their cost objects, such as cost centers and product groups. The USP2 demo

company was used to create this recording.

1. Go to Cost accounting > Setup > Cost control workspace configuration.

2. Click New.

3. In the Name field, type a value.

4. In the Description field, type a value.

5. Select Yes in the Published field.

6. Expand the Data filtering section.

7. In the Cost control unit field, enter or select a value.

8. In the Budget original version field, enter or select a value.

9. In the Cost element dimension hierarchy field, enter or select a value.

10. In the Cost object dimension hierarchy field, enter or select a value.

11. Expand the Assign calculation records section.

12. Click New.

13. In the list, mark the selected row.

14. In the Fiscal calendar period field, enter or select a value.

15. In the Actual version field, enter or select a value.

16. Expand the Fiscal periods per column section.

17. Select Yes in the Current period field.

18. Expand the Columns to display for costs section.

19. Select Yes in the Fixed cost field.

20. Select Yes in the Variable cost field.

21. Select Yes in the Total cost field.

22. Click Save.

23. Close the page.

24. Go to Cost accounting > Workspaces > Cost control.

25. Select a statement to see fixed, variable, total, and unclassified costs for the selected fiscal periods.

26. In the Fiscal calendar period field, enter or select a value.

27. In the Cost object dimension hierarchy node field, enter or select a value.

If you set this option to Yes, users who are assigned one of these roles can see the report in the Cost

control workspace: cost accounting manager, cost accountant, cost accountant clerk, or cost object

controller. If you set this option to No, only users who are assigned one of these roles can see the

report in the Cost control workspace: cost accounting manager, cost accountant, or cost accountant

clerk.

After you've selected a Cost object dimension hierarchy, expand the Cost element dimension hierarchy

to see the desired cost values. For example, you can expand the hierarchy to Manufacturing overhead

to see the value.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/tasks/configure-cost-control-workspace-parameters.md
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Overview

Setup

NOTENOTE

This topic explains how you can propagate the access-level security in Cost accounting to row-level security in

Microsoft Power BI. This functionality helps guarantee that users see only Power BI data that they are granted

access to.

The Cost accounting analysisCost accounting analysis  Microsoft Power BI content uses Power BI row-level security to limit a user's

access. Security is based on the access-level organizational hierarchy that is set up in the Cost accounting

parameters. For more information about the Cost accounting analysisCost accounting analysis  Power BI content, see Cost accounting

analysis Power BI content.

To propagate access-level security to Power BI, the owner of the Power BI content must follow these steps.

The user who publishes the Cost accounting analysisCost accounting analysis  Power BI content automatically becomes the owner. Only an

owner can set up security in Power BI. Additionally, until an owner adds other users on PowerBI.com, no one except the

owner can see any data in the Cost accounting analysisCost accounting analysis  Power BI content.

1. Publish the definition file to Power BI.

2. Sign in to PowerBI.com.

3. Find the dataset for the Cost accounting analysisCost accounting analysis  Power BI content.

4. Open the security page.

5. The Cost object controllerCost object controller  role is already created. Add other members who are part of the Cost

accounting access-level organizational hierarchy.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/setup-security-cost-accounting-content-pack.md
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Updating security

Disabling security

Additional resources
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Users who are added to the Cost object controllerCost object controller  role will see only the data that they are allowed to see,

according to the definition in the Cost accounting access-level organizational hierarchy.

Row-level security applies to tiles and reports that are embedded from Power BI.

If updates are made to access-level security in Cost accounting, and you want Power BI to reflect those updates,

you must update the entity store for the Cost accounting analysisCost accounting analysis  Power BI content. After you complete the

entity store update you must update the artifacts on PowerBI.com. For more information about how to do an

entity store update, see Power BI integration with Entity store. The owner of the Cost accounting analysisCost accounting analysis

Power BI content must also do an entity store update if new users are granted access to the organizational

hierarchy. Additionally, the owner must add the new users to the Cost object controllerCost object controller  role on PowerBI.com,

so that row-level security is applied for them.

We assume that your organization wants to restrict data access. If, for some reason, the security parameters are

disabled when you run Cost accounting, the owner must add users to the Cost accountantCost accountant role in Power BI

instead. If you change security from an enabled state to a disabled state, it's a good idea to remove users from

the Cost object controllerCost object controller  role. And vice versa if you re-enable security. Users can belong to both roles. Joint

access is the union of both roles. In the case of the Cost accounting analysisCost accounting analysis  Power BI content, users who

have joint access have unrestricted data access. If your goal is to apply restricted access, users must be assigned

only to the Cost object controllerCost object controller  role. These row-level security updates take effect immediately. Affected

users should refresh their browsers.

To learn more about Power BI row-level security, see Manage security on your model in Power BI.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Overview

Accessing the Power BI content
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Metrics that are included in the Power BI content

This topic describes what is included in the Cost accounting analysisCost accounting analysis  Microsoft Power BI content. It explains

how to access the Power BI reports, and provides information about the data model and entities that were used

to build the content.

The Cost accounting analysisCost accounting analysis  Power BI content is intended for cost controllers or anyone who is responsible

for performing cost control of an organization. It includes the key metrics, such as cost, magnitude, and cost rate

by actual cost, budget cost, and flexible budget cost. It uses transaction data from the Cost accountingCost accounting module

and provides an aggregate view of costs for the whole organization in one reporting currency. Managers can

filter the data by cost objects to perform cost control of their organizational units, even if the organization can

have several legal entities.

Because the Cost accounting analysisCost accounting analysis  content highlights variances between the actual costs and budgeted

costs, managers can be notified about positive and negative trends for their operational units. Managers can

drill down to the cost element hierarchies or individual cost elements. In this way, managers can gain detailed

insight into how cost variances have occurred, and then take effective action.

The Cost accounting analysisCost accounting analysis  content lets cost accountants analyze how cost flows through the cost objects

of the whole organization.

To learn more about Cost accounting, see Cost accounting home page.

By defining access-level security in Cost accounting and combining it with row-level security in Power BI, you

can grant all cost object owners access to the Cost accounting analysisCost accounting analysis  Power BI content. All data in the

visualizations will then be filtered based on the access level that is controlled in Cost accounting. To learn more

about access-level security and row-level security, see Set up security for the Cost accounting analysis Power BI

content.

You can find the Cost accounting analysisCost accounting analysis  Power BI content in the Shared assets library in Microsoft

Dynamics Lifecycle Services (LCS). For more information about how to download the content and implement it

in your organization, see Power BI content in LCS from Microsoft and your partners.

Be sure to download the Cost accounting analysisCost accounting analysis  content that applies to the version of Microsoft Dynamics

365 that you're using.

KB 4011327 is a prerequisite for this Power BI content. After you sign in to LCS, you can access the KB here at

https://fix.lcs.dynamics.com/issue/results/?q=kb4011327.

The content includes a set of report pages. Each page consists of a set of metrics that are visualized as charts,

tiles, and tables. The following table provides an overview of the visualizations in the Cost accountingCost accounting

analysisanalysis  Power BI content.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/cost-accounting-analysis-content-pack.md
https://blogs.msdn.microsoft.com/dynamicsaxbi/2016/12/12/power-bi-content-from-microsoft-and-your-partners/
https://fix.lcs.dynamics.com/issue/results/?q=kb4011327
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Cost control by fiscal period Actual cost and Budget cost by Cost
element hierarchy level

Actual cost vs Budget cost

Budget variance by Cost element
hierarchy level

Actual cost rate vs Budget cost rate

Top 10 Budget variance in percentage
by Cost element

Actual magnitude vs Budget
magnitude

Cost control by Year to date Actual cost and Budget cost by
Calendar Year Period

Actual cost vs Budget cost

Budget variance by Calendar Year
Period

Actual cost rate vs Budget cost rate

Top 10 Budget variance in percentage
by Cost element

Actual magnitude vs Budget
magnitude

Cost rate by fiscal year Actual cost rate by Cost behavior Actual cost rate vs Budget cost rate

Actual cost rate, Budget cost rate
variance, Budget cost rate percentage
and Budget cost rate by Cost element
hierarchy level

Actual magnitude vs Budget
magnitude

Budget variance by Cost element
hierarchy level

Top 10 Budget variance in percentage
by Cost element

Flexible budget by fiscal period Actual cost, Budget cost and Flexible
budget cost by Cost element hierarchy
level

Actual magnitude vs Budget
magnitude

Budget variance and Flexible budget
variance by Cost element hierarchy
level

Actual cost vs Flexible budget cost

Actual cost, Budget cost and Flexible
cost by Cost behavior and Cost
element hierarchy level

Actual cost rate vs Flexible budget cost
rate

Cost statement by fiscal period Actual cost by Cost element hierarchy
level and Cost object dimension
member name

Actual cost by Cost object dimension
member name and Cost element
dimension member name

Understanding the data model and entities
The following data is used to fill the report pages in the Cost accounting analysisCost accounting analysis  Power BI content. This data



EN T IT YEN T IT Y
KEY  A GGREGAT EKEY  A GGREGAT E
M EA SUREM EN TM EA SUREM EN T

DATA  SO URC E F O RDATA  SO URC E F O R
DY N A M IC S 365DY N A M IC S 365 F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Cost accounting
entries

SUM(Amount) CAMDATAAggregate
dCostEntry

Amount The amount in the
Cost accounting
ledger currency.

Statistical entries SUM(Magnitude) CAMDATAAggregate
dStatisctialEntry

Magnitude
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Actual cost CALCULATE('Cost accounting entries'[Measure], 'Transaction
versions'[ISSOURCEVERSIONBUDGET_VALUE] = 0)

Budget cost CALCULATE('Cost accounting entries'[Measure], 'Transaction
versions'[ISSOURCEVERSIONBUDGET_VALUE] = 1)

Budget cost variance [Budget cost] - [Actual cost]

Budget variance percentage IF([Budget cost] = 0, blank(), [Budget variance] / [Budget
cost])

Actual magnitude CALCULATE('Statistical entries'[FullMagnitude], 'Transaction
versions'[ISSOURCEVERSIONBUDGET_VALUE] = 0)

Budget magnitude CALCULATE([FullMagnitude], 'Transaction
versions'[ISSOURCEVERSIONBUDGET_VALUE] = 1)

Statistical budget variance [Budget magnitude] - [Actual magnitude]

Statistical budget variance percentage IF([Budget magnitude] = 0, blank(), [Statistical budget
variance] / [Budget magnitude])

Actual cost rate IF([Actual magnitude] = 0, BLANK(), [Actual cost] / [Actual
magnitude])

Budget cost rate IF([Budget magnitude] = 0, BLANK(), [Budget cost] / [Budget
magnitude])

Budget cost rate variance [Budget cost rate] - [Actual cost rate]

Budget cost rate variance percentage IF([Budget cost] = 0, blank(), [Budget cost rate variance] /
[Budget cost rate])

Fixed budget cost CALCULATE([Budget cost], 'Cost accounting
entries'[COSTBEHAVIOR] = 1)

is represented as aggregate measurements that are staged in the Entity store. The Entity store is a Microsoft SQL

Server database that is optimized for analytics. For more information, see Power BI integration with Entity store.

The following key aggregate measurements are used as the basis of the content.

The following table shows how the key aggregate measurements are used to create several calculated measures

in the content's dataset.



Variable budget cost CALCULATE([Budget cost], 'Cost accounting
entries'[COSTBEHAVIOR] = 2)

Fixed flexible budget cost [Fixed budget cost]

Variable flexible budget cost IF([Budget magnitude] = 0, BLANK(), ([Variable budget cost]
/ [Budget magnitude]) * [Actual magnitude])

Flexible budget cost [Fixed flexible budget cost] + [Variable flexible budget cost]

Flexible budget variance [Flexible budget cost] - [Actual cost]

Flexible budget variance percentage IF([Flexible budget cost] = 0, BLANK(), [Flexible budget
variance] / [Flexible budget cost])

Flexible budget cost rate IF([Actual magnitude] = 0, BLANK(), [Flexible budget cost] /
[Actual magnitude])

Flexible budget cost rate variance [Flexible budget cost rate] - [Actual cost rate]

Flexible budget cost rate variance percentage IF([Flexible budget cost rate] = 0, BLANK(), [Flexible budget
cost rate variance] / [Flexible budget cost rate])
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EN T IT YEN T IT Y EXA M P L ES O F  AT T RIB UT ESEXA M P L ES O F  AT T RIB UT ES

Cost accounting ledgers Cost accounting ledger

Cost control units Cost control unit name

Cost element dimensions Cost elements dimension name, Cost element dimension
member name, Cost element dimension member description

Cost object dimensions Cost object dimension name, Cost object dimension member
name, Cost object dimension member description

Statistical dimensions Statistical dimension name, Statistical dimension member
name, Statistical dimension member description

Cost object dimension hierarchies Cost object dimension hierarchy name, Cost object
dimension hierarchy level, Cost object dimension hierarchy
tree

Cost element dimension hierarchies Cost element dimension hierarchy name, Cost element
dimension hierarchy level, Cost element dimension hierarchy
tree

Statistical dimension hierarchies Statistical dimension hierarchy name, Statistical dimension
hierarchy level, Statistical dimension hierarchy tree

Transaction versions Version name

The following key dimensions are used as filters to slice the aggregate measurements to achieve greater

granularity and provide deeper analytical insights.



Fiscal calendars Calendar, Calendar description

Fiscal years Calendar year

Fiscal periods Calendar year period
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Overview

Data securityData security

Actions, views, and linksActions, views, and links

This topic provides information about the Cost controllingCost controlling mobile workspace. This workspace lets cost center

managers view information about cost center performance anytime and anywhere.

This mobile workspace is intended to be used with the Finance and Operations mobile app.

The Cost controllingCost controlling mobile workspace provides an instant view of the current performance of cost centers by

comparing actual costs against the budgeted costs. You can drill down to the status of individual cost elements.

For example, an employee receives an invitation to an international conference, but the organization must cover

all the travel expenses. The employee asks their manager whether they can attend the conference. The manager

opens the Cost controllingCost controlling mobile workspace on their mobile device to see whether there is budget for the

employee to attend the conference.

The data in the Cost controllingCost controlling mobile workspace is secured through user credentials. Cost center managers

are allowed to see data only for their own cost center. The access-level security is managed in the CostCost

accountingaccounting module.

Cost accountants define the configuration of the Cost controllingCost controlling mobile workspace in the Cost accountingCost accounting

module. After the workspace is published to the mobile app, it's available in the app. Therefore, all cost center

managers in the organization can view data in the same format.

The Cost controllingCost controlling mobile workspace provides the following actions, views, and links:

Actions:Actions:

NOTENOTE

Use Select configurationSelect configuration to select a layout.

Use Select cost objectSelect cost object to select the cost centers to filter data on.

The cost centers that appear in the list depend on the access that is granted in the Cost accountingCost accounting

module.

Views:Views: Based on the actions that are selected and the configuration in the Cost accountingCost accounting module,

you can view the following information on the cards:

Actual vs budget (current period)

Actual vs revised budget (current period)

Actual vs budget (previous period)

Actual vs revised budget (previous period)

Actual vs budget (year to date)

Actual vs revised budget (year to date)

The following amounts are shown on every card: Actual, Budget, Variance, and Variance %.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/cost-controlling-mobile-workspace.md
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Links:L inks:

Details for current period

Details for previous period

Details for year to date

When you select a link, a card is shown for each cost element. The following amounts are shown on

every card: Actual, Budget, Budget variance, Budget variance %, Revised budget, Revised budget variance,

and Revised budget variance %.

The prerequisites differ, based on the version of Microsoft Dynamics 365 that has been deployed for your

organization.

If Finance has been deployed for your organization, the system administrator must publish the CostCost

controllingcontrolling mobile workspace. For instructions, see Publish a mobile workspace.

If version 1611 with Platform update 3 or later has been deployed for your organization, the system

administrator must complete the following prerequisites.

file:///T:/eiye/ac1a/dynamics365/finance/cost-accounting/media/cost-controlling.png
file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/publish-mobile-workspace.html


Implement KB 4013633. System administrator KB 4013633 is an X++ update or
metadata hotfix that contains the
Cost controllingCost controlling mobile workspace.
To implement KB 4013633, your
system administrator must follow
these steps.

Publish the Cost controllingCost controlling mobile
workspace.

System administrator See Publish a mobile workspace.
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Download and install the mobile app

Sign in to the mobile app

View the performance of your cost center by using the Cost
controlling mobile workspace

1. Download the metadata hotfix
from Microsoft Dynamics
Lifecycle Services (LCS).

2. Install the metadata hotfix.

3. Create a deployable package
that contains the SCMMobileSCMMobile
model, and then upload the
deployable package to LCS.

4. Apply the deployable package.

Download and install the Finance and Operations mobile app:

For Android phones

For iPhones

1. Start the app on your mobile device.

2. Enter your Dynamics 365 URL.

3. The first time that you sign in, you're prompted for your user name and password. Enter your credentials.

4. After you sign in, the available workspaces for your company are shown. Note that if your system

administrator publishes a new workspace later, you will have to refresh the list of mobile workspaces.

1. On your mobile device, select the Cost controllingCost controlling workspace.

file:///T:/eiye/ac1a/dynamics365/dev-itpro/migration-upgrade/download-hotfix-lcs.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/migration-upgrade/install-metadata-hotfix-package.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/create-apply-deployable-package.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/apply-deployable-package-system.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/publish-mobile-workspace.html
https://go.microsoft.com/fwlink/?linkid=850662
https://go.microsoft.com/fwlink/?linkid=850663
file:///T:/eiye/ac1a/dynamics365/finance/cost-accounting/media/pull-to-refresh-list-of-workspaces.png
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2. Select Cost object controllingCost object controlling.

3. Select ActionsActions .

4. Select Select configurationSelect configuration to select a cost controlling layout.

5. Select DoneDone.

6. Select ActionsActions .

7. Select Select cost objectSelect cost object to select the cost centers that you've been granted access to.

8. Select DoneDone.

9. View the overall performance of your cost center.

10. Select the Details for current per iodDetails for current per iod link.

11. View the performance of individual cost elements.

12. You can also search for specific cost elements.
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White paperWhite paper

BlogsBlogs

Task guidesTask guides
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Cost management (video) lets you work with the valuation and accounting of raw materials, semi-finished

goods, finished goods, and work-in-progress assets. It is the process of defining, managing, and reporting

Inventory accounting and Manufacturing accounting.

You can define cost policies in the following areas:

Predetermined cost

Inventory accounting

Manufacturing accounting

Indirect cost accounting

Ledger integration

For example, you can define which inventory valuation methods, such as FIFO, Weighted average, Standard cost,

or Moving average that you want to apply to products in the Item model group in Inventory accounting.

You can access Inventory accounting and Manufacturing accounting from the Cost administrationCost administration and CostCost

analysisanalysis  workspaces. These workspaces provide a comprehensive overview of the current status, key

performance indicators (KPIs), and detection of deviation.

Manufacturing accounting lets you handle Job order costing in production orders and batch orders, as well as

Backflush costing in lean manufacturing.

The Cost management Power BI content provides managerial insight into inventory and work-in-progress (WIP)

inventory, and how cost flows through them by category over time. The information can also be used as a

detailed supplement to the financial statement.

Go to the Microsoft Dynamics 365 Roadmap to see what new features have been released and what new

features are in development.

BOM calculation by using a costing sheet describes how to set up a costing sheet that includes material and

manufacturing, and how the setup affects the BOM calculation results. To better explain the topics, it provides

concrete scenarios and data that demonstrates the effect of the various settings and configurations.

You can find opinions, news, and other information about Cost management on the Dynamics AX Manufacturing

R&D Team blog and Supply Chain Management in Dynamics AX R&D Team blog. Although some of these posts

were written for the previous version of Cost management, the same concepts still apply, and the procedures

are also similar in the current version.

Additional help is available as task guides. To access task guides, click the Help button on any page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/cost-management-home-page.md
https://www.youtube.com/watch?v=vXzlC-mOBcg&feature=youtu.be
file:///T:/eiye/ac1a/dynamics365/dev-itpro/analytics/cost-management-content-pack.html
https://roadmap.dynamics.com/
https://www.microsoft.com/download/details.aspx?id=101937
https://blogs.msdn.microsoft.com/axmfg
https://blogs.msdn.microsoft.com/dynamicsaxscm
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Prerequisites for standard costs overview
2/18/2021 • 3 minutes to read • Edit Online

This topic describes the basic steps for using standard costs. Subsequent steps depend on the company's

operations. For example, the steps differ for a nonmanufacturing environment, a manufacturing environment

that doesn't use routings, and a manufacturing environment that uses routings.

To set up standard costs, follow these steps.

1 . Create an item model group for standard costs.1 . Create an item model group for standard costs.

Use the Item model groupsItem model groups  page to create a new group for standard costs, and assign an inventory model of

Standard costStandard cost. The identifier for the item model group should be meaningful, such as Std CostStd Cost. Select the

check boxes to indicate that the group should allow financial negative inventory, and that it should post physical

inventory and financial inventory. This standard cost group will be assigned to items.

2. Define ledger accounts that are related to standard cost var iances.2 . Define ledger accounts that are related to standard cost var iances.

Use the Char t of accountsChar t of accounts  page to define ledger accounts that are related to standard cost variances. These

ledger accounts must be defined before they can be assigned on the PostingPosting page. The ledger accounts can

reflect item groups and cost groups.

3. Assign ledger accounts to item postings that are related to standard cost var iances.3 . Assign ledger accounts to item postings that are related to standard cost var iances.

Use the PostingPosting page to assign the ledger accounts that are related to standard cost variances. You can specify a

variance's ledger account by item (or item group) and by cost group (or cost group type), or you can specify that

the ledger account applies to all items and all cost groups. These options correspond to cost relations for tables,

groups, and all.

Before you define the item posting rules, use the Transaction combinationsTransaction combinations  page to enable cost relations (for

tables, groups, and all).

4 . Define inventor y parameters that are related to standard costs.4 . Define inventor y parameters that are related to standard costs.

Use the Inventor y accountingInventor y accounting tab on the Inventor y accounting policies setup > ParametersInventor y accounting policies setup > Parameters

page to define two cost control parameters that are related to standard costs.

In the Cost breakdownCost breakdown field, select NoneNone or Sub ledgerSub ledger . If you select Sub ledgerSub ledger , the cost

breakdown is an active cost breakdown. An active cost breakdown is critical for calculating,

retaining, and viewing cost group segmentation across a multilevel product structure for standard

cost items. When the cost breakdown is active, you can report and analyze inventory, work in

process (WIP), and cost of goods sold (COGS) per cost group in a single-level, multilevel, or total

format. When the cost breakdown is active, if you activate a manufactured item's cost, the cost

group segmentation will be stored in the item's cost record.

If you select NoneNone, cost group segmentation won't be maintained for standard cost items. In other

words, a manufactured item's standard cost will be calculated and maintained as a single amount,

without cost group segmentation. The cost contributions of manufactured components will be

aggregated into the single amount.

In the Variances to standardVariances to standard field, select SummarizedSummarized or Per cost groupPer cost group. If you select Per costPer cost

groupgroup, you can identify purchase price variances and production variances by cost group. You can also

identify the four types of production variances: the lot size, quantity, price, and substitution variances. If

you select SummarizedSummarized, you can't identify variances by cost group, and you can't identify the four types

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/prerequisites-standard-costs.md
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of production variances. You can just view a summarized production variance.

The policy about variance to standard works independently of the cost breakdown policy. In other words,

you can select a cost breakdown policy of NoneNone and select variances per cost group, so that production

variances by cost group will still be captured.

5. Create costing versions for standard costs.5 . Create costing versions for standard costs.

Use the Costing version setupCosting version setup page to create one or more costing versions for standard costs. Each costing

version must be designated by a costing type of Standard costStandard cost and must allow content to include cost data.

6 . Prepare an existing customer to use standard costs.6 . Prepare an existing customer to use standard costs.

Customers who want to change their existing items to a standard cost inventory model must use the StandardStandard

cost conversionscost conversions  page.

Standard cost conversion overview

How to set up standard costs for direct materials in Dynamics 365 for Finance and Operations

Standard direct labor costs in Dynamics 365 for Finance and Operations
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1. Define a standard cost conversion record and the associated
costing version

This article provides a process overview to help you set up and run a standard cost conversion. The steps listed

are intended to be completed after you've completed the prerequisites for a standard cost conversion.

Use the Standard cost conversionsStandard cost conversions  page to convert the inventory model for a batch of selected items from

an actual costing approach to a standard costing approach. The conversion process involves a prerequisite

inventory close, several steps during a transition period, which is defined by a transition start date and a

planned conversion date, and then the conversion and an associated inventory close.

Inventory close before the transition period – An inventory close represents a prerequisite step because it

settles an item’s open transactions using the old valuation method. During the transition period, you can

enter and post backdated transactions, such as invoices, so that you can close the previous period. The

inventory close date must be one day before the transition start date to ensure a clean break from the old

valuation method.

Conversion steps during the transition period – Use the Standard cost conversionsStandard cost conversions  page to create a

conversion record that also contains the user-defined identifier for a new costing version. You identify the

items that require conversion, and then enter the items’ pending standard costs in the new costing version.

You perform a check of the selected items to identify issues that might prevent conversion, resolve the issues,

and then perform another check. After the items have successfully passed the checks, you change the status

of the conversion record to ReadyReady . On the planned conversion date, you perform the conversion and

optionally include an inventory close. An item’s inventory movements during the transition period are

posted and valued according to the old inventory model. Then, after the conversion is successfully

completed, the inventory movements are revalued to standard cost.

Inventory close before the conversion – The inventory close can be included as part of the conversion on the

planned conversion date, or it can be performed as a separate step before the conversion.

After the conversion process is successfully completed, the inventory model for each item is based on standard

cost, and the item’s standard cost is enabled. Subsequent inventory transactions will be valued at the item’s

standard cost. In addition, the system converts the item’s physical inventory transactions for receipts and issues

to standard cost based on the conversion date. The system also converts the item’s financial on-hand inventory

to standard cost, and posts the difference in value as an inventory revaluation. Any transactions that occur after

the conversion are valued at the item’s standard cost. You cannot enter backdated transactions before the

conversion date, because an inventory close must be performed one day before the conversion date. A

conversion can only be performed if an inventory close was performed one day earlier. This inventory close

cannot be canceled.

Use the Standard cost conversionsStandard cost conversions  page to create a conversion record. You can create a new conversion

record only when existing conversion records have been completed. The duration of the planned transition

period is defined by the transition start date and the planned conversion date. A planned transition period can

be as short as one day. A planned transition period helps to ensure that the conversion process has enough time

to complete all its steps. An inventory close must be performed on a date that is one day before the transition

start date, to help ensure that settlements are completed before you start the conversion process. To make sure

that the transition start date and inventory close date are correctly aligned, you can either change the transition

start date to one day after an existing inventory close or perform an inventory close. When you enter a
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conversion record, you also enter a user-defined identifier for a new costing version that will contain the

standard costs for converted items. The costing version is generated automatically when you save the

conversion record.

The new costing version is dedicated to the conversion record, as the ConversionConversion costing type indicates. The

dedicated costing version is similar to a costing version for standard costs and contains the item cost records for

items that are associated with the conversion record. The dedicated costing version for a conversion record has

the following settings, which you should review and modify on the various tabs as required:

Costing type:Costing type: This field should be set to Standard costStandard cost.

Version:Version: The identifier reflects the information that is entered on the conversion record for the costing

version ID.

Name:Name: By default, the name is blank. You can optionally enter a name.

Block :Block : This field should be set to NoNo. You can enter cost records into the costing version until you change the

status of the conversion record to ReadyReady . A status of ReadyReady  indicates that the selected items have been

checked, and that changes to cost records should not be permitted.

Block activation:Block activation: This field should be set to YesYes . You can't manually activate a pending cost record in the

dedicated costing version. Activation occurs when you perform the conversion.

From date:From date: The from date reflects the planned conversion date that is entered on the conversion record.

S ite:S ite: Leave this field blank, so that cost records can be entered for any site.

Allow price type field group:Allow price type field group: Set this field to YesYes , so that only cost price records can be entered.

Fallback pr inciple:Fallback pr inciple: This field is set to NoneNone. Change the fallback principle to ActiveActive if you require cost

information that has been activated in other costing versions. For example, cost information about

components, cost categories, and indirect costs might be required in order to calculate the costs of

manufactured items.

Fallback costing version:Fallback costing version: Leave this field blank.

Item cost information in the dedicated costing version can be maintained only from the Standard costStandard cost

conversionsconversions  page. You can't use the Costing version setupCosting version setup page or the Costing version maintenanceCosting version maintenance

page to calculate costs for the costing version during conversion. However, you can use these pages to maintain

the dedicated costing version after you've completed the conversion process.

Use the Standard cost conversionsStandard cost conversions  page to identify the individual items that should be converted to standard

cost. You can add multiple items by using the Add items to standard cost conversionAdd items to standard cost conversion page. In general, you

should include all manufactured items in a single conversion record to help ensure that costs are calculated

correctly.

Use the Item priceItem price page to enter pending standard costs in the dedicated costing version for purchased items

and transfer items. Cost records are site-specific, and an item's pending costs must be entered for every site. Use

the Item priceItem price page to calculate pending standard costs for manufactured items. A manufactured item's

pending costs should be calculated for every manufacturing site, unless the site represents a transfer site. In this

case, the pending costs should be entered manually. Some items might have color, size, or configuration product

dimensions. On the Standard cost conversionsStandard cost conversions  page, the Use cost pr ice by var iantUse cost pr ice by var iant check box shows the

standard cost for every combination of product dimensions. When this check box is cleared, you must enter only



5. Check and resolve any issues for the items that are being
converted

6. Change the status of the conversion record to Ready

7. Back up the database before conversion

8. Perform the conversion when the conversion record has a Ready
status

9. Validate and reconcile the inventory values for the converted items

a pending cost for the item.

Use the Standard cost conversion checksStandard cost conversion checks  report to identify issues for the items that are being converted. If

an item doesn't have any issues, its status in the conversion record is changed to CheckedChecked. If an item has issues,

you must resolve the issues and then run the report again until the item's status is changed to CheckedChecked. If you

can't resolve an item's issues in a timely manner, you can optionally delete the item from the conversion record

and then convert the item later.

When the status of the conversion record is changed to ReadyReady , the system performs a final check before it runs

a standard cost conversion. The status is changed to ReadyReady  only if the following conditions have been met:

Every item in the conversion record has a status of CheckedChecked.

An inventory close was performed on a date that is one day before the transition start date. To make sure

that the transition start date and inventory close date are correctly aligned, you can either change the

transition start date to one day after an existing inventory close or perform an inventory close.

The backup lets you restore the database if errors are encountered during the conversion.

The conversion process requires that an inventory close be performed on a date that is one day before the

planned conversion date. This requirement helps ensure that back-dated transactions can't be entered during

the transition period. If an inventory close hasn't yet been performed, you will be asked if you want to perform it

as part of the conversion process. The conversion process handles one item at a time. It starts with the lowest

items in a product structure, based on the item's low-level code. When an item has been successfully converted,

its status in the conversion record is changed to Conver tedConver ted. If the conversion process is interrupted, any items

that haven't been successfully converted will still have a status of CheckedChecked. Successful completion of the

conversion process has the following effects:

The status of the conversion record is changed from ReadyReady  to CompletedCompleted, and the status of each selected

item is changed from CheckedChecked to Conver tedConver ted.

The item model group for converted items is changed so that it reflects a new group that has a standard cost

inventory model.

The standard costs for the converted items have been enabled in the dedicated costing version.

The costing type of the costing version is changed from ConversionConversion to Standard costStandard cost, and the costing

version is now like other costing versions for standard costs.

The Variance analysis statementVariance analysis statement report lets you analyze revaluation variance and the Inventor y valueInventor y value

repot lets you view inventory value on a specific date.

Analyze revaluation variances. Use the Variance analysis statementVariance analysis statement report to view inventory revaluation

variances for the converted items. You can also use the Standard cost transactionsStandard cost transactions  page to view the

inventory revaluation transactions for the converted items that have inventory.
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Analyze the inventory value before the transition start date. Use the Inventor y valueInventor y value report to view

inventory values for the converted items. For the To date for the report, use a date that is one day before the

transition start date.

Analyze the inventory value before the conversion date. Use the Inventor y valueInventor y value report to view inventory

values for the converted items. As the To date for the report, use a date that reflects one day before the

conversion date.

Analyze the inventory value on the conversion date. Use the Inventor y valueInventor y value report to view inventory

values as of the conversion date. Both the From date and the To date for the report should match the

conversion date. The report selection criteria should reflect the converted items.

Analyze back-dated inventory movements. Use the Inventor y valueInventor y value report to view back-dated inventory

movements that were entered after the conversion. The "From date and the To date for the report should

correspond to the transition start date and the conversion date, minus one day. The report selection criteria

should reflect the converted items. The report shows inventory movements that were made at standard cost

during the transition period.

Prerequisites for a standard cost conversion
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This topic discusses tasks to perform before you run a standard cost conversion.

Before you run a standard cost conversion, follow these steps:

1. Define an item model groupitem model group for standard costs. Use the Item model groups page to create an item

model group that uses a standard cost inventory model. When setting up a standard cost conversion, you

assign this item model group to the items that are being converted.

2. Assign a cost groupcost group to each item.

The cost group that is assigned to a purchased item can act as the basis for assigning ledger accounts

that are related to standard costs. This can include assigning ledger accounts for purchase price

variances. In a manufacturing environment, the cost group that is assigned to purchased components

also provides cost segmentation in the calculated costs of a manufactured item.

The cost group that is assigned to a manufactured item can act as the basis for assigning ledger

accounts that are related to standard costs, such as assigning ledger accounts for production

variances.

3. Assign a standard order quantitystandard order quantity  to a manufactured item when it has constant costs. The standard

order quantity for a manufactured item acts as an accounting lot size for amortizing, or prorating,

constant costs. These can include setup times in routing operations or a constant component quantity in a

bill of material (BOM).

4. Assign general ledger accountsgeneral ledger accounts  that are related to standard costs, especially the revaluation variance.

Use the PostingPosting page (Inventor y managementInventor y management > SetupSetup) to assign general ledger accounts that are

related to standard costs. As a minimum for the standard cost conversion process, you must assign the

account for the revaluation variance for all items and all cost groups. Use the Char t of accountsChar t of accounts  page to

define the general ledger accounts that will be needed for standard costs. Use the TransactionTransaction

combinationscombinations  page to enable cost relations (for tables, groups, and all) before you define the item

posting rules.

5. Define the inventory parameters that are related to standard costs. Use the Number sequencesNumber sequences  tab on

the Inventor y and warehouse management parametersInventor y and warehouse management parameters  page to assign a number sequence to

revaluation vouchers. A revaluation voucher is generated when the standard cost conversion creates a

change of an item's inventory value. Use the Inventor y and warehouse management parametersInventor y and warehouse management parameters

page to define Cost Control parameters (on the Inventor y accountingInventor y accounting tab) to define two parameters

that are related to standard costs.

Use the Cost breakdownCost breakdown field to select No or Sub ledger. The selection of Sub ledger is termed

an active cost breakdown. An active cost breakdown is very important for calculating, retaining,

and viewing cost group segmentation across a multilevel product structure for standard cost

items. When the cost breakdown is active, you can report and analyze the following in a single

level, multi-level, or total format:

a. Inventory

b. Work in process (WIP)

c. Cost of goods sold (COGS) per cost group

An active cost breakdown means that if you enable a manufactured item's cost, the result will be

stored in the cost group segmentation in the item's cost record. If you put no value in the CostCost

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/prerequisites-standard-cost-conversion.md


NOTENOTE

breakdownbreakdown field, the cost group segmentation will not be maintained for standard cost items.

That is, a manufactured item's standard cost will be calculated and maintained as a single amount

without cost group segmentation, and the cost contributions of manufactured components will be

aggregated into the single amount.

Use the Variances to standardVariances to standard field to select summarized or per cost group. The selection of per

cost group enables you to identify purchase price variances and production variances by cost

group. This also enables you to identify the four types of production variances (the lot size,

quantity, price, and substitution variances). If you select summarized, you cannot identify variances

by cost group, and you cannot identify the four types of production variances. You can only view a

summarized production variance. The policy about variance to standard is independent of the cost

breakdown policy. That is, you can select a cost breakdown policy of none, and select variances per

cost group, so that production variances by cost group will still be captured.
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Example

Updates to standard cost data can be managed by using two different approaches - the one-version approach or

the two-version approach.

The one-version approach uses a single costing version that contains all cost records. These records include the

original costs and all cost updates.

The two-version approach uses one version that contains records of the original costs and a second version that

contains records of all cost updates. A primary advantage of the two-version approach is the clear delineation

and tracking of cost updates in a separate costing version, without affecting the original costing version. The

two-version approach can be used to identify multiple incremental updates, where each incremental update has

a separate costing version that contains the incremental cost records.

The following example illustrates how the one-version and two-version approaches can be used for updating

standard costs in a manufacturing environment. For example, updates that reflect new items or error

corrections. Assume that a single costing version represents the standard costs for the current year. The

identifier for this version is 2020-STD. Version 2020-STD contains the current active costs for all items.

Additionally, it contains all routing-related cost categories and overhead calculation formulas that were known

at the start of the year 2020. 2020-STD is the original costing version.

One-version approach to cost data updatesOne-version approach to cost data updates  − In the one-version approach, the original costing version

2020-STD contains all cost records. Cost updates are recorded in 2020-STD and set to a status of Pending.

The pending costs can be manually entered for new purchased items, or they can be calculated for a

manufactured item to reflect corrections. When the one-version approach is used, the BOM calculations do

not require a fallback data source because all active costs are contained in the costing version. After the

pending costs become active, the original costing version 2020-STD will again contain all the current active

costs.

Two-version approach to cost data updatesTwo-version approach to cost data updates  − The two-version approach requires an additional costing

version that contains only the cost updates. The identifier for this version is 2020-STD-CHANGES. Cost

updates are recorded in 2020-STD-CHANGES and are set to a status of Pending. With the two-version

approach, the BOM calculations of pending costs for manufactured items require a fallback data source. This

is because the additional costing version 2020-STD-CHANGES contains only a subset of cost data. The

fallback can be expressed as the active costs or as the costing version 2020-STD, because both identify the

source of cost data when it is not included in 2020-STD-CHANGES. After the pending costs become active,

the costing version 2020-STD-CHANGES will contain the current active costs that reflect the updates,

whereas the original costing version 2020-STD will not be affected. When the two-version approach is used,

blocking policies for the original costing version should be set up to prevent updates. Identical blocking

policies should be set up for the additional costing version, except for the specified from-date and the

selective use of blocking policies to allow for updates. The specified from-date should be updated with each

batch of changes to reflect the scheduled activation date.

This example used one additional costing version for managing updates throughout the year 2020. More than

one additional costing version can be used, such as a separate version for each batch of updates. When more

than one additional costing is used, the fallback must be expressed as the active costs, because the active costs

are spread over multiple costing versions.
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Financial dimensions for the standard cost revaluation
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Activating a new standard price will typically revaluate the on-hand inventory value by standard cost revaluation

transactions. Usually, the financial dimensions of the item are then posted on the transactions. However, if you

would like to control whether and how the financial dimensions are posted, use feature management to turn on

the feature named Options of defaulting financial dimensions for inventory standard cost revaluation. After

enabling this feature, go to Cost management > Inventor y accounting policies setup > ParametersCost management > Inventor y accounting policies setup > Parameters  and

set the new Origin of financial dimensionOrigin of financial dimension drop-down list to one of the following values:

NoneNone – No financial dimensions are posted on the revaluation transactions. If your account structure

includes a required financial dimension, the revaluation process will still run, but it will create accounting

entries that have no financial dimensions. In this case, users will receive a warning message first, so they can

cancel the revaluation if necessary.

TableTable – The financial dimensions of the item are posted on the revaluation transactions. This is the default

setting and is consistent with the original system behavior without turning on the feature Options of

defaulting financial dimensions for inventory standard cost revaluation.

PostingPosting – The financial dimensions of the transaction that is being revalued are posted on the revaluation

transactions. By default, the financial dimensions from the original transaction's inventory account will be

used for both the inventory account and the revaluation account.
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Related topics

NOTENOTE

This topic describes the restrictions that apply to a costing version for standard costs.

The following restrictions help guarantee adherence to standard costing principles:

Charges must be included in an item's cost. The charges for a manufactured item represent the amortized

constant costs in the bill of materials (BOM) and route information. Therefore, the charges must be

included in the unit cost. The charges for a purchased item are also included in the item's unit cost.

Calculation of standard costs for manufactured items must be based on the cost records in a costing

version for standard costs. Alternative sources of cost data can be used only with a costing version for

planned costs, such as purchase price trade agreements for purchased items. Alternative sources of cost

data are defined by the BOM calculation group.

BOM calculations must be performed in a single-level explosion mode.

The item cost data for standard costs can be copied to another costing version that contains standard costs or

planned costs. However, the item cost data for planned costs can't be copied to a cost version that contains

standard costs, because the restrictions that are listed earlier in this topic don't apply to planned costs.

Costing versions overview

Update standard costs in a non-manufacturing environment

Prepare to maintain standard costs for manufactured items
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Bills of material (BOM) calculations use data from several sources to calculate the standard costs of a

manufactured item. The sources include information about items, bills routings, indirect cost calculation

formulas, and the costing version.

The purchased item information that is used in a standard cost BOM calculation includes the following:

Cost − A purchased item’s costs are maintained as site-specific cost records in a costing version for standard

costs. Each cost record has an effective date, and the BOM calculation date determines which cost record will

be used. For example, a BOM calculation with a future calculation date might use a cost record with a

pending status and a future effective date.

Cost group − The cost group that is assigned to a purchased item provides the basis for cost segmentation in

the calculated costs of a manufactured item.

Warning conditions that are embedded in the item’s BOM calculation group enable the BOM calculation to

identify potential problems. This can be when the purchased item has a zero cost, a zero quantity in a BOM,

or an out-of-date cost record. The applicable warning conditions can be overridden when initiating a BOM

calculation.

The manufactured item information that is used in a standard cost BOM calculation includes the following:

Standard order quantity for inventory − The item’s standard order quantity for inventory, acts as the default

accounting lot size for amortizing constant costs in a BOM calculation. The accounting lot size will also reflect

the order quantity multiple if it is specified.

Warning conditions that are embedded in the item’s BOM calculation group enable the BOM calculation to

identify potential problems. One example could be that the manufactured item does not have a BOM or

route. The applicable warning conditions can be overridden when initiating a BOM calculation.

The bill of material information that is used in a standard cost BOM calculation includes the following:

BOM version − The BOM version that is assigned to the manufactured item has effective from and to dates,

and a status for approved and active. The bill version can be company-wide or site-specific, and it can

optionally reflect quantity breakpoints.

BOM line item quantity − A component typically has a variable quantity required, but it can be a constant.

The component quantity is typically expressed for producing one parent item, but it may be expressed per

100 or per 1000 to handle decimal precision issues. The component quantity can also be calculated based on

measurements.

BOM line item scrap − A component can have a variable or constant quantity for planned scrap.

BOM line item valid dates − A component can have valid from and to dates.

BOM line item type of production − The costing lot size for amortizing constant costs will reflect the BOM

calculation quantity and a make-to-order explosion mode, because the BOM calculation assumes that the

manufactured component will be produced to the exact quantity instead of its standard order quantity.

Sub-BOM for a manufactured component − A manufactured component can optionally have a specified

BOM version, which would be used instead of the item’s current active BOM version in a BOM calculation.

Sub-route for a manufactured component − A manufactured component can optionally have a specified

route version, which would be used instead of the item’s current active route version in a BOM calculation.

Operation number and the impact of operation scrap percentages − The operation number links a
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component to a specific operation, and operations can have a scrap percentage. The linkage enables BOM

calculations to account for scrap percentages and cumulative scrap percentages across multiple operations

on the component’s required quantity.

Ignore BOM line item in cost calculations − A component can be ignored for BOM calculation purposes.

The operations resource information that is used in a standard cost BOM calculation includes:

Hourly costs − The hourly costs that are associated with an operations resource are expressed as cost

categories that are assigned to set up time and run time. These cost categories should be identified for

resource groups and operations resources. The hourly costs that are associated with a cost category can be

site-specific or company-wide.

Per unit costs − Some manufacturing environments assign operations resource costs per unit of output,

which would be expressed as a different cost category for quantity. For example, the quantity-related costs

can reflect piece rates for labor, or a paint manufacturer may assign operations resource costs per gallon of

output.

Overriding operations resource information on routing operations − The resource information about cost

categories will be inherited by operations, where it can be overridden. BOM calculations will use the cost

category information that is specified on the routing operations.

Cost group for a cost category − The cost group that is assigned to a cost category provides cost

segmentation in the calculated costs of a manufactured item. For example, different cost groups might be

used to segment the calculated costs that are associated with machines and labor or with setup and run time.

The route information that is used in a standard cost BOM calculation includes:

Route version − The route version that is assigned to the manufactured item has effective from and to dates,

and a status for approved and active. The route version must be site-specific, and it can optionally reflect

quantity breakpoints.

Routing operation time − The time can be specified for runtime and setup time. The hourly time is typically

expressed for producing one parent item, but it may be expressed per 100 or per 1000 to handle decimal

precision issues.

Routing operation time for secondary resources − A secondary resource has the same operation number as

the primary resource, and the same routing operation time. For example, an operation might require a

machine as the primary resource and labor and tools as secondary resources.

Routing operation scrap percentage − BOM calculations will account for scrap percentages and cumulative

scrap percentages across multiple operations. This applies to the required time for routing operations and

the required quantity for components that are linked to operation numbers.

Cost categories for a routing operation − Operations resource information about cost categories will be

inherited by operations, where it can be overridden. BOM calculations will use the cost category information

that is specified on the routing operations.

The manufacturing overhead information that is used in a standard cost BOM calculation includes:

Surcharge − A surcharge calculation formula reflects a percentage of value, such as 100 percent, that is tied

to a specific cost group, such as labor.

Rate − A rate calculation formula reflects an amount per unit, such as USD 10.00 per hour, that is tied to a

specific cost group, such as labor.

Time-based versus material-based overhead − The manufacturing overhead can be tied to routing

operations or material components.

The costing version information that is used in a standard cost BOM calculation includes:

Costing type − The costing version must contain standard costs. Several restrictions apply to BOM

calculations that use standard costs. For example, these restrictions specify that miscellaneous charges must

be included in unit costs and that the BOM calculation explosion mode must be single level.



NOTENOTE

Mandated fallback principle − The costing version can mandate the use of a fallback principle, such as using

a specified costing version or the active cost records. The mandated fallback principle typically applies to a

costing version that represents the incremental updates in a two-version approach for cost updates.

Blocking flag for pending costs − A blocking flag can prevent BOM calculations of the pending cost for

manufactured items.

Specified from-date − The specified from-date will act as the default calculation date for all BOM calculations

that involve the costing version.

Specified site − A specified site will limit BOM calculations to the single site.

Content of the costing version must include costs − The content must include costs. It can optionally include

sales prices in order to calculate suggested sales prices for manufactured items.

Several sources of information can be specified when initiating a BOM calculation. This includes the site, the

calculation date, and the costing version.
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NOTENOTE

This article provides guidance about how to update standard costs in a manufacturing environment.

Updates can reflect new items, cost categories, or indirect cost calculation formulas. They can also reflect

corrections and cost changes. The type of update affects the steps that you must complete to update standard

costs, as illustrated in the following cases:

Enter expected standard cost changes for purchased items, and then change the status of the item cost

records to ActiveActive on the appropriate date. However, don't recalculate the costs of manufactured items that

use the purchased items.

Enter standard costs for a new purchased item, but don't recalculate the costs of manufactured items that

have a bill of materials (BOM) version that contains the new purchased item as a component.

Correct or change the cost of a purchased item, or change the cost group that is assigned to a purchased

item, and calculate the cost for all manufactured items that have a BOM version that contains the purchased

item as a component.

Change the cost for a cost category, and calculate the cost for all manufactured items that have a route

version that contains routing operations that use the cost category.

Change the cost categories that are assigned to routing operations or the cost group that is assigned to cost

categories. Then calculate the cost for all manufactured items that have a route version that contains routing

operations that use the cost category.

Change an indirect cost calculation formula, and calculate the cost for all manufactured items that are

affected by the change.

Change or add a manufacturing site for a manufactured item, and calculate the item's manufactured cost for

the site.

Calculate, or recalculate, the cost for a manufactured item, and recalculate the cost for all manufactured items

that have a BOM version that contains the manufactured item as a component.

Calculate costs for a new manufactured item, based on its defined, approved, and active BOM and route

information.

Each case requires careful consideration about how to update standard costs.
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This article provides guidance for updating standard costs for a new manufactured item.

The following guidelines assume that you use a two-version approach to update standard costs. In this

approach, one costing version contains the standard costs that were originally defined for the frozen period, and

the second costing version contains the incremental updates that pertain to the new manufactured items. The

incremental updates are entered as cost records in the second costing version, and eventually they are enabled.

The two-version approach requires that you define a second costing version. Here are the guidelines for

defining this costing version:

Assign a costing type of Standard costStandard cost.

Assign a significant identifier that indicates the contents of the costing version, such as 2016-UPDATES2016-UPDATES .

In the Allow price typesAllow price types  field group, make sure that Cost pr iceCost pr ice is set to YesYes .

Allow cost records to be entered for all sites (that is, leave the S iteSite field blank). If you enter a site, cost

records can be entered only for that site.

Use a fallback principle of ActiveActive.

To add new manufacturing items throughout the frozen period, follow these steps.

1. Use the Costing version setupCosting version setup page to enable cost records to be entered into the second costing version

that contains the incremental updates. Prevent the activation of pending costs, where activation is allowed

after pending costs have been completely and accurately defined. Indicate a blank from-date as a policy in

the costing version, and then enter the from-date when you enter each cost record. The from-date should

represent a date before the new items are purchased or manufactured.

2. Use the Item priceItem price page to enter cost records for new purchased items. For each cost record, enter the

costing version that contains incremental updates, and use a from-date that comes before the expected

manufacturing date for new manufactured items.

3. Calculate the cost of new manufactured items by using the CalculationCalculation page. Open the CalculationCalculation page

from the Costing version maintenanceCosting version maintenance page, and then select the costing version that contains the

incremental updates. Use the selection criteria to specify the new manufactured item and any one of its

manufactured components. In a multilevel product structure, you might also have to specify any parent item

that contains the new manufactured items as a component. Enter a from-date for the bill of materials (BOM)

calculation that corresponds to the start of manufacturing for the new manufactured items. The from-date

should be in the effective dates for the item’s BOM version and route version. Note:Note: A missing cost record

can indicate a new manufactured item. BOM calculations can be limited to items that have missing costs.

4. Verify the completeness and accuracy of the calculated costs for new manufactured items. Use the CompleteComplete

page to review the calculated costs for each item cost record, and also review any Infolog warning messages.

Alternatively, use the CalculationCalculation page to review the calculated costs.

5. Use the Costing version setupCosting version setup page to change the blocking flag to allow activation of the pending cost

records in the second costing version.

6. Use the Activate pr icesActivate pr ices  page (which you open from the Costing version maintenanceCosting version maintenance page) to enable

all pending cost records in the second costing version. You can also enable the pending cost records for

individual items by clicking the ActivateActivate button on the Item priceItem price page.

7. Use the Costing version setupCosting version setup page to change the blocking flags in the second costing version to prevent

additional data maintenance. The blocking policies prevent the entry of new pending costs and the activation

of pending costs.
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NOTENOTE

This article provides guidance for updating standard costs in a non-manufacturing environment.

The following guidelines assume that you use a two-version approach to update standard cost. In this approach,

one costing version contains the standard costs that were originally defined for the frozen period, and the

second costing version contains the incremental updates. Each update is entered as a cost record that is

enclosed in the second costing version, and eventually it's enabled. An alternative, one-version approach uses

the set of standard costs that was originally defined. The two-version approach requires that you define a

second costing version. Here are the guidelines for defining this costing version:

Assign a costing type of Standard costsStandard costs .

Assign a meaningful identifier that indicates the contents of the costing version, such as 2016-UPDATES2016-UPDATES .

Make sure that the content includes cost records.

Allow cost records to be entered for all sites. If you specify a site, cost records can be entered only for that

site.

Indicate a fallback principle of NoneNone. The fallback principle applies only to cost calculations for manufactured

items.

To correct, adjust, or update standard costs for new items, follow these steps.

1. Use the Costing versionCosting version setupsetup page to enable cost data to be entered into the second costing version.

Optionally, prevent the activation of pending costs, so that activation will be allowed after pending costs have

been completely and accurately defined. You can also optionally enter a date in the From dateFrom date field. As a

general guideline, use the date when you intend to enable the incremental updates. Alternatively, leave the

From dateFrom date field blank for the costing version, and then enter a date in the From dateFrom date field for each cost

record.

2. Use the Item priceItem price page to enter updates as item cost records that are enclosed in the second costing

version.

3. Use the Item pricesItem prices  report to verify the completeness and accuracy of the item cost records that are

enclosed in the second costing version.

4. Use the Costing version maintenanceCosting version maintenance page to change the blocking flag to allow activation of the pending

cost records that are enclosed in the second costing version.

5. Use the Activate pr icesActivate pr ices  page (which you open from the Costing version maintenanceCosting version maintenance page) to activate

all pending item cost records that are enclosed in the second costing version. You can also activate the

pending cost records for individual items by clicking the Activate pending pr iceActivate pending pr ice button on the Item priceItem price

page.

6. To prevent additional data maintenance, use the Costing version setupCosting version setup page to change the blocking flags

that are enclosed in the second costing version. The blocking policies will prevent the entry of new pending

costs and the activation of pending costs.
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Related topics

This topic describes the steps for preparing to maintain costs for manufactured items. The steps for

manufactured items differ slightly from the steps for purchased items.

Policies that are assigned to manufactured items can affect the cost calculations for the parent manufactured

items. To prepare to maintain costs for manufactured items, follow these steps.

1. Assign an item model group to the manufactured item.

The item model group identifies that standard costs will be used.

2. Assign an item group to the manufactured item.

The item group contains ledger accounts that apply to the manufactured item. The ledger accounts for a

manufactured item that has a standard cost inventory model include several production variances, the

cost change variance, and the inventory cost revaluation.

3. Assign the inventory unit of measure to the item.

The item's costs are always expressed in the item's inventory unit of measure.

4. Don't assign a cost group to the manufactured item unless the item will be treated as a purchased item.

5. Assign a bill of materials (BOM) calculation group to the manufactured item.

The item's BOM calculation group defines warning conditions that apply. In that way, when a BOM

calculation is done, warning messages can be generated about possible sources of calculation errors. For

example, a warning message can identify when an active BOM or route doesn't exist. The BOM calculation

group contains a stop explosion policy that indicates when a manufactured item should be treated as a

purchased item.

6. If the manufactured item has constant costs, assign a standard order quantity to it.

The standard order quantity is an accounting lot size for amortizing constant costs. Examples of constant

costs include setup times in routing operations and a constant component quantity in the BOM.

7. Define the BOM for the manufactured item.

One or more BOM versions can be defined for the manufactured item. Verify that the versions that you

want have been marked as approved and active, and that they have the effective dates that you want. The

BOM version can be company-wide or site-specific.

8. Define the routing for the manufactured item.

One or more route versions can be defined for the manufactured item. Verify that the versions that you

want have been marked as approved and active, and that they have the effective dates that you want. The

route version must be site-specific.

If you want to use routing information for costing purposes, additional preparation steps are required. For

example, the cost categories that are assigned to routing operations must be correct and completed.
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Amortize constant costs for a manufactured item

Set up products that can be produced or procured
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Costing versions for standard or planned costs
Standard costsStandard costs

Planned costsPlanned costs

Entering costs

This article provides information about costing versions, how to maintain them, and the types of data that you

can include in them. The primary purpose of a costing version is to contain cost records about items, cost

categories, and calculation formulas for indirect costs.

A costing version can serve one or more purposes, depending on the data that the costing version contains. The

primary purpose of a costing version is to contain cost records about items, cost categories, and calculation

formulas for indirect costs. A costing version can contain a set of standard cost records or a set of planned cost

records that are based on the costing type that is assigned to the costing version.

A costing version can support a standard cost inventory model for items, where the costing version contains a

set of standard cost records about items and manufacturing processes. Cost data about manufacturing

processes is expressed in terms of the cost categories for routing operations and the calculation formulas for

manufacturing overheads.

A costing version can contain a set of planned cost records about items and manufacturing processes. A costing

version that contains planned costs is often used to support cost calculation simulations, such as simulations of

the effect that cost changes to purchased materials or manufacturing processes has on the calculated costs of

manufactured items. The item cost records for planned costs can also be used to support an actual cost

inventory model by providing the initial values for item costs. These values include the calculation of planned

costs for manufactured items.

Data maintenance for cost records in a costing version involves entering costs for purchased items and for items

that are transferred between sites. Additional data maintenance for manufacturers involves entering costs for

cost categories that are associated with routing operations, entering calculation formulas for the indirect costs

that reflect manufacturing overhead, and calculating costs for manufactured items.

The item cost data in a costing version consists of one or more cost records for each item. When an item cost

record is first entered, it has PendingPending status and an intended effective date. When you activate the item cost

record, the status is updated to ActiveActive, and the effective date is updated to the activation date. Different item

cost records can reflect different sites, effective dates, or statuses. When you calculate costs for manufactured

items for a future date, the bill of materials (BOM) calculation uses cost records that have the relevant effective

date, regardless of whether the status is PendingPending or ActiveActive. An item's current active cost record is used to

estimate production order costs and to value inventory transactions under a standard costing inventory model.

The maintenance of cost records for cost categories and indirect cost calculation formulas resembles the

maintenance of item cost records.

Two blocking policies for a costing version determine whether pending costs can be maintained and whether

the pending cost can be activated. Use the blocking policies to permit data maintenance, and then use them to

prevent data maintenance for cost records in a costing version.

A costing version can also contain data about item sales prices or purchase prices for BOM calculation purposes.
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Item purchase prices for BOM calculations

NOTENOTE

The main reason for including data about sales prices is to retain a manufactured item’s calculated sales price.

The calculated sales price can then be analyzed to determine how components, routing operations, and

overhead contribute to the cost and sales price.

A secondary reason for including data about sales prices is to define the sales price records for component

items. These records can then be used to calculate the sales price of manufactured items. You first define the

sales price model that is embedded in a BOM calculation group, and assign the BOM calculation group to

purchased items. Then, when you perform BOM calculations that use planned costs, you select the cost price

model of the BOM calculation group.

Otherwise, the sales price records for items are used only as reference information, regardless of whether the

records are manually entered or calculated. By activating an item’s sales price record, you can update the item’s

base sales price. However, the base sales price isn't site-specific and can be manually overridden. The item’s base

sales price is used as a default sales price on sales orders and sales quotations.

The main reason for enabling purchase price data is to define purchase price records for component items, so

that these records can be used to calculate the costs of manufactured items. The item purchase price records

must be manually entered.

To enable purchase price content, you first define a BOM calculation group that contains a cost price model for

the item’s purchase price, and assign the BOM calculation group to purchased items. You then use a cost price

model for the BOM calculation group when you perform BOM calculations that use planned costs to calculate

the sales price of manufactured items.

The purchase price records for items are also used as reference information. By changing the status of an item’s

purchase price record from PendingPending to ActiveActive, you can update the item’s base purchase price. However, the

base purchase price isn't site-specific and can be manually overridden. The item's base purchase price is used as

a default purchase price on purchase orders.
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Setting up the costing sheet involves two objectives. As the first objective, you define the format for displaying

cost of goods sold information about a manufactured item or production order. The formatted display is termed

a costing sheet. As the second objective, you define the basis for calculating indirect costs. The costing sheet

setup builds on the cost group feature for displaying information and for the indirect cost calculation formulas.

The two objectives of costing sheet setup are described in this article.

A costing sheet is the formatted display of information about the cost of goods that are sold for a manufactured

item or a production order. When you set up a costing sheet, you define the format for the information and also

define the basis for calculating indirect costs. The costing sheet setup builds on the cost group features for

displaying information and for the formulas that are used to calculated indirect cost. Here is more information

about the two objectives of costing sheet setup:

Define the format for the costing sheet.Define the format for the costing sheet. The user-defined format for a costing sheet identifies the

segmentation of costs that contain a manufactured item’s cost of goods sold. For example, the information

about an item’s cost of goods sold can be segmented into material, labor, and overhead, based on cost

groups. These cost groups are assigned to items, cost categories for routing operations, and indirect cost

calculation formulas. The format for the costing sheet typically requires intermediate totals when multiple

cost groups have been defined. For example, multiple cost groups that are related to material can be

aggregated. The definition of a costing sheet format is optional, but a costing sheet format must be defined if

indirect costs will be calculated.

Define the basis for calculating indirect costs.Define the basis for calculating indirect costs. Indirect costs reflect manufacturing overhead that is

associated with the production of a manufactured item. An indirect cost calculation formula can be expressed

as either a surcharge or a rate. A surcharge represents a percentage of value, whereas a rate represents an

amount per hour for a routing operation. A cost group defines the basis for the calculation formula, such as a

100-percent surcharge for a labor cost group or a USD 50.00 hourly rate for a machine cost group. If you

want to define a calculation formula and its cost group basis, the costing sheet setup requires that you

identify the cost group that represents the overhead, and select whether a surcharge or rate approach is

used.

Each calculation formula must be entered as a cost record. The cost record consists of a specified costing

version, a surcharge percentage or a rate amount, the cost group basis, a status, and an effective date. When a

cost record is first entered, it has PendingPending status and an effective date. When you activate the cost record, the

status is updated to so that the record is the current active record, and the effective date is updated to the

activation date. The cost record can also specify a site for a site-specific calculation formula. Alternatively, you

can leave the S iteSite field blank to indicate that the calculation formula is a company-wide formula. The cost

record can optionally consist of a specified item or item group when the calculation formula has been marked as

a per-item formula.

The current active cost records for indirect cost calculation formulas are used to estimate production order costs.

They are also used to calculate actual costs that are related to actual consumption of time and material. Pending

cost records are used in bill of materials (BOM) calculations for a future date.

Two blocking policies for a costing version determine whether pending costs can be maintained, and whether

the pending cost can be started. Use the blocking policies to permit data maintenance, and then to prevent data

maintenance for the cost data in a costing version.

After you define the costing sheet format and calculations for indirect costs, you must perform a separate step

to validate and save the information. The costing sheet represents a company-wide format for consistently
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displaying information about the costs of goods sold.

The costing sheet is displayed as part of the Calculate item costCalculate item cost page. The costing sheet can be displayed for a

manufactured item’s calculated cost record on the Item priceItem price page or for an order-specific calculation record

on the BOM calculation resultsBOM calculation results  page. It can also be displayed as part of the Pr ice calculationPrice calculation page for a

production order.
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Guidelines for defining the simulation costing version

Costing versions

This article explains how you can simulate the effects of cost changes on a manufactured item’s calculated costs

by using a separate costing version for planned costs.

You can simulate the effects of cost changes on the calculated costs of a manufactured item by using a separate

costing version for planned costs. Use this separate costing version to enter pending cost records that reflect

incremental cost changes, and to calculate the cost impact on manufactured items. Because the Active costs

fallback principle will be used in the bill of materials (BOM) calculations, only the incremental cost changes must

be entered.

Use the following guidelines when you define the costing version for simulations:

Assign a costing type of Planned costsPlanned costs .

Assign a meaningful identifier for the costing version, such as S imulationSimulation.

Make sure that the content includes cost records.

Allow the entry of cost records. Don't block the entry of pending costs.

Allow the entry of cost records for all sites. If you specify a site, you will limit the entry of cost records to that

site.

Prevent the activation of pending costs. Only pending costs must be entered for cost records in the

simulation costing version.

Don't enter a "from" date. A calculation date will be entered for each BOM calculation that uses the

simulation costing version.

Specify a fallback principle of Current activeCurrent active. The fallback principle enables incremental cost changes to be

entered for simulation purposes but uses the current active costs as the source for all other cost records. We

assume that all current active costs exist for all other cost records.

Specify a cost price model of Version cost pr iceVersion cost pr ice, but don't restrict calculations. For example, the simulations

can also use the BOM calculation groupBOM calculation group cost price model to indicate the source of cost contribution data

for purchased items.

Specify an explosion mode of MultilevelMultilevel , but don't restrict calculations. The simulations can use other

explosion modes.

The following scenarios illustrate how the simulation costing version is used to simulate the impact of cost

changes. Before you enter a simulated cost change, delete the pending cost records in the simulation costing

version, so that you have a clean starting point. Use the Item priceItem price page to view and delete the pending cost

records that are related to item prices and cost category prices.

Simulate the cost change for a purchased item. For example, the cost change might reflect an expected

increase or decrease in the cost of critical purchased materials. To define the different cost for a purchased

item, use the Item priceItem price page to enter a pending cost record in the simulation costing version.

Simulate the cost change for a cost category. For example, the cost change might reflect an expected increase

or decrease in labor rates, or in the hourly rates for operations resources. To define the different cost for a
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cost category, use the Cost categor y pr iceCost categor y pr ice page to enter a pending cost record in the simulation costing

version.

Simulate the cost change in an indirect cost calculation formula. For example, the cost change might reflect

an expected increase or decrease in manufacturing overhead. To define the change in an indirect cost

calculation formula, use the Costing sheet setupCosting sheet setup page to enter a pending cost record in the simulation of

costing version, and to validate and save the change.

After you enter the simulated cost changes, calculate the costs for manufactured items that are affected by the

cost changes. Use the CalculationCalculation page for the simulation costing version, and identify the selected

manufactured items that will be affected by the cost changes. The BOM calculations apply to all manufactured

items unless you select specific items. Alternatively, you can use the BOM calculation option for where-used

updates. View the item cost records in the simulation costing version to analyze how the simulated cost changes

affected the costs of the selected manufactured items. Use the Item priceItem price page and the Calculate item costCalculate item cost

page to view and analyze the costs.
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Enable compare item prices storage

Generate a Compare item prices storage report

This topic explains how to run a Compare item prices storageCompare item prices storage report and make the output available digitally,

either as an interactive page in Dynamics 365 Supply Chain Management, or as an exported document in any of

several formats.

When you view the report in your browser, columns and aggregate balances are dynamically adjusted,

depending on your configured layout. You can sort the results, filter them, drill down into the data, and more.

Report results are stored in the Compare item pricesCompare item prices  data entity, which lets you filter and export the results to

a format such as CSV or Microsoft Excel.

The Compare item prices storageCompare item prices storage report is helpful in cases where the output contains many lines. For

example, the output will contain many lines if you have more than 40,000 items holding a pending item price in

the costing version.

Before you can use this feature, you must enable it on your system. Administrators can use the feature

management settings to check the feature status and enable it if needed. Here, the feature is listed as:

ModuleModule - Cost management

Feature nameFeature name - Compare item price storage

Follow these steps to generate and store a Compare item prices storageCompare item prices storage report:

NOTENOTE

1. Go to Cost management > Inquir ies and repor ts > Predetermined cost repor ts > CompareCost management > Inquir ies and repor ts > Predetermined cost repor ts > Compare

item prices storageitem prices storage.

2. Select NewNew  to open the Compare item pricesCompare item prices  pane. Set the following options to define which prices to

compare in your report:

On the ParametersParameters  FastTab, give the report a unique NameName and use the fields in the Pending pr icesPending pr ices

to compareto compare and Pr ices used for comparisonPrices used for comparison sections to define which prices and dates to

compare.

On the Records to includeRecords to include FastTab, set up filters and constraints to define which data to include in

the report.

On the Run in the backgroundRun in the background FastTab, set up how, when, and the frequency at which you want to

generate the report.

This report is always executed as part of a batch job.

3. Select OKOK to apply your settings and close the pane.

4. After the batch job is completed, it will be listed on the Compare item prices storageCompare item prices storage page. You may

need to refresh the page to see the report.
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Export the Compare item prices storage report

After you've generated a report, you can view and explore it at any time as follows:

1. Go to Cost management > Inquir ies and repor ts > Predetermined cost repor ts > CompareCost management > Inquir ies and repor ts > Predetermined cost repor ts > Compare

item prices storageitem prices storage.

2. Select a report from the list.

3. Do one of the following:

Select Over viewOver view  to get an overview of your report results.

Select View detailsView details  to get a more detailed view of your report

4. After the selected view opens, you can do the following:

Select almost any column heading to sort or filter the table by values in that column, just as with most

standard forms in Supply Chain Management. Note, you can't sort or filter the Net change price %Net change price %

column because it's a calculated field.

Select Dimension displayDimension display  to open a pane where you can choose which dimension column to include

on the form. Set Save setupSave setup to YesYes  if you'd like to save these settings so they will be preserved the

next time you open the report. Select OKOK to apply your settings and close.

Select any row in the form and then select View detailsView details  to see more information about the selected

item. You'll be able to drill down into the data from here.

Select any row in the form and then select View comparison char tView comparison char t to see an interactive graphical

representation of your results as they relate to your selected item. You can explore these results by

selecting various graphical elements in the chart and chart legend.

Select any row in the form and then select View calculation detailsView calculation details  to see more information about

calculations related to the selected item. You'll be able to drill down into the data from here.

Each report that you generate is stored in the Compare item pricesCompare item prices  data entity. You can use the standard data

management features of Supply Chain Management to export data from this entity to any supported data

format, including CSV or Microsoft Excel.

The following is an example of how to export a Compare item prices storageCompare item prices storage report:

1. Go to System administration > Workspaces > Data managementSystem administration > Workspaces > Data management.

2. Select the Expor tExpor t button in the Data managementData management section.

3. The Expor tExpor t page opens, which you'll use to set up your export job. Start by giving your job a GroupGroup

namename.

4. In the Selected entitiesSelected entities  section, select Add entityAdd entity  to open a dialog box where you can set the following

options:

Entity nameEntity name - Select Compare item pricesCompare item prices .

Target data formatTarget data format - Choose the format that you want to export to.

5. Select AddAdd to add the new row and then select CloseClose to close the dialog box.

6. Usually you'll export one report at a time. To do this, set up a FilterFilter  for the row you just added to the

Inquir yInquir y  pane. This will let you define which reports from the Compare item pricesCompare item prices  entity that you

want to include in your export. Set the following filter options to export a single report:

On the RangeRange tab, select AddAdd to add a new row.

Set TableTable to Compare item pricesCompare item prices .
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Set Derived tableDerived table to Compare item pricesCompare item prices .

Set FieldField to the field that you want to filter by. Usually you'll use Execution nameExecution name or ExecutionExecution

timetime.

Set Cr iter iaCriter ia to the value from your selected field that you want to look for (either the name of the

report or the time the report was generated).

If necessary, add more rows to the RangeRange table until you have uniquely identified the report that

you're looking for.

7. Select OKOK to save your settings and close.

8. Select SaveSave to save your export setup.

9. Open the Expor t optionsExpor t options  tab and select Expor t nowExpor t now  to generate the export file.

10. The Execution summar yExecution summar y  page opens, where you can see the status of your export job and a list of

entities that were exported. Select the Compare item pricesCompare item prices  entity listed in the Entity processingEntity processing

statusstatus  area and then select Download fileDownload file to download the data exported from that entity.

For more information about how to use data management to export data, see Data import and export jobs

overview.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Cost objects
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Cost object x x

Inventory object x x x x

Accumulation of costs and quantities

This article provides information about costs objects, and explains how costs and quantities are accumulated. A

cost object is an entity that costs and quantities are accumulated for. A cost object entity can be either a product

or product variants, such as variants for style and color.

The Cost objectsCost objects  page lists all cost objects that are registered on a product. The cost objects are defined by

data from the following sources:

Product

Product dimension group

Storage dimension group

Tracking dimension group

Note:Note: A cost object represents a cost element of the Direct mater ialDirect mater ial  type only. A cost object and an inventory

object differ in the way that a cost object is defined by the inventory dimensions that are selected for financial

inventory. For example, an item has the following configuration:

S ite:S ite: Physical inventory = Yes, Financial inventory = Yes

Warehouse:Warehouse: Physical inventory = Yes, Financial inventory = No

Batch No.:Batch No.: Physical inventory = Yes, Financial inventory = No

The following table shows what is a cost object and what is an inventory object.

The value in the ValueValue fieldis a sum of the following values:

The value in the QuantityQuantity  field is a sum of the following values:

The Average unit costAverage unit cost field is a calculated field. The value is calculated by dividing the ValueValue value by the

QuantityQuantity  value.

Physical cost amount

Financial cost amount

Adjustments

Received

Deducted

Posted quantity

Note:Note: The **Include physical value **parameter has no effect on the preceding calculations.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/cost-object.md
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Product dimension group

Storage dimension group

Tracking dimension group

What's new or changed

Cost entries

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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The demo data company used to create this procedure is USMF. This procedure is intended for the cost

controller.

1. Click Cost administration.

2. Click Released products.

3. Use the Quick Filter to filter on the Item number field with a value of 'm0004'.

4. On the Action Pane, click Manage costs.

5. Click Cost objects.

6. Click Physical quantity.

7. Click Dimensions display.

8. Clear the Location check box.

9. Click OK.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/tasks/view-cost-object-balance.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

The demo data company used to create this procedure is USMF. This procedure is intended for the cost

controller.

1. Click Cost administration.

2. Click Released products.

3. Use the Quick Filter to find records. For example, filter on the Item number field with a value of 'd0005'.

4. On the Action Pane, click Manage costs.

5. Click Cost objects.

6. Click Inventory statement and KPIs.

7. In the From date field, enter a date.

8. In the To date field, enter a date.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/tasks/view-inventory-statement-kpi-cost-object.md
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Examples
Example 1: No cost entries are createdExample 1: No cost entries are created

Example 2: Cost entries are createdExample 2: Cost entries are created

Example 3: One cost entry is createdExample 3: One cost entry is created

Cost entries page

VO UC H ERVO UC H ER DAT EDAT E REF EREN C EREF EREN C E N UM B ERN UM B ER LOT  IDLOT  ID Q UA N T IT YQ UA N T IT Y A M O UN TA M O UN T

00001 01-01-2015 Purchase
order

100001 0000101 100.00 1000.00

00002 20-01-2015 Purchase
order

100001 0000101 100.00

00003 31-01-2015 Adjustment 100001 0000101 15.00

This article provides information about cost entries and when they are created. A cost entry is a record that

registers the quantity and cost of a given event.

Cost entries are aggregations of inventory transactions that are recorded on active financial inventory

dimensions.

A transfer journal event is registered. The event transfers one piece of item A from location A to location B. The

Location inventory dimension isn't considered part of the cost object. Therefore, the event creates two inventory

transactions and no cost entries.

A transfer journal event is registered. The event transfers one piece of item A from site 1 to site 2. The Site

inventory dimension is considered part of the cost object. Therefore, the event creates two inventory

transactions and two cost entries.

A product receipt event is registered for a purchase order. The event registers 100 pieces of item A at a unit cost

of 10.00 U.S. dollars (USD). Because item A uses a serial number to track the purpose of inventory management,

a unique serial number is created for each item that is received. Therefore, the event creates 100 inventory

transactions and one cost entry.

The new Cost entr iesCost entr ies  page lets you view and control registrations of quantities and costs. This page

complements the Inventor y transactionInventor y transaction and Inventor y settlementInventor y settlement pages. Records are registered in

chronological order for an event. Therefore, you can quickly find and control the accumulated costs of a specific

event or all events that are related to a document. Here is an example:

A product receipt event is registered for item A. One hundred pieces are received at a unit cost of 10.00 USD.

A few days after the invoice event is registered, the cost increases to 11.00 USD. Therefore, the total amount

is 1,100 USD. A second voucher is created to account for the difference of 100 USD.

A few days later, a miscellaneous charge of 15.00 USD to cover the transportation cost is registered on the

purchase order.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/cost-entries.md
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Additional resources

NOTENOTE

The Cost entr iesCost entr ies  page enables filtering by document ID and document date.

Cost entries are available only for cost objects or released products.

Cost objects

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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This procedure shows how to view cost entries for a cost object. The demo data company used to create this

procedure is USMF. This procedure is intended for the cost controller.

1. Click Cost administration.

2. Click Released products.

3. Use the Quick Filter to find records. For example, filter on the Item number field with a value of 'm0004'.

4. On the Action Pane, click Manage costs.

5. Click Cost objects.

6. Click Cost entries.

7. Use the Quick Filter to filter on the Number field with a value of 'p000031'.

If cost entries are blank, set From date to January 31, 2012 and To date to December 31, 2012.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/tasks/view-cost-entries-cost-object.md
https://aka.ms/BAG_Docs_Language_Survey
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Cost groups provide the basis for segmenting and analyzing cost contributions in a manufactured item’s

calculated cost, such as the cost contributions for material, labor, and overhead. Cost group segmentation has

several synonyms within manufacturing environments, such as cost breakdown, cost decomposition, or cost

classification.

Cost group segmentation has several synonyms within manufacturing environments, such as cost breakdown,

cost decomposition, or cost classification. Cost group segmentation can serve several purposes. Here are some

examples:

It can segment costs for different types of material, such as ingredients and packaging material for a canned

goods product, based on the cost groups that are assigned to items.

It can segment costs for different types of operations resources, such as different types of labor or machines,

based on the cost groups that are assigned to cost categories that are related to operations resources and

routing operations.

It can segment costs for setup time and run time in routing operations, based on the cost groups that are

assigned to cost categories that are related to the routing operations.

It can segment costs for different types of overhead, such as labor-related and machine-related overhead,

based on cost groups that are assigned to indirect costs in the costing sheet setup.

It can act as the basis for calculating various types of manufacturing overhead in the costing sheet setup. This

overhead can include different types of overhead that are related to routing information about operations

resources, or information about setup time and run time. Manufacturing overhead can also be related to cost

contributions of component material, reflecting a lean manufacturing philosophy that eliminates the need for

routing information.

Cost group segmentation applies to a manufactured item’s calculated cost, regardless of whether that cost was

based on standard costs or planned costs. The Summar ySummar y  page displays this segmentation by cost group, by

level, or by both cost group and level.

The ability to retain cost group segmentation across multiple levels in a product structure is known as splitting.

Splitting applies only to manufactured items that use a standard cost inventory model. If splitting isn't used, the

cost of a manufactured component is treated as a material cost contribution. The inventory parameter for cost

breakdown by subledger indicates that cost group segmentation will be retained across multiple levels in

standard cost calculations. By contrast, if a policy has no levels, cost group segmentation applies only to a

single-level calculation. For example, the Cost rollup by cost groupCost rollup by cost group page displays the cost group

segmentation across multiple levels for standard cost items.

Cost group segmentation can also apply to variances for a standard cost item. A second inventory parameter

defines whether variances are identified by cost group or just summarized.

A cost group can be assigned a cost group type and a behavior for supplemental segmentation purposes.

Cost group typeCost group type − Each cost group must be assigned a cost group type to indicate that the cost group

applies to direct material, direct manufacturing, or direct outsourcing, or to designate it as indirect or

undefined. A cost group that is designated as direct material can be assigned to items. A direct

manufacturing cost group can be assigned to cost categories. A direct outsourcing cost group can be

assigned to a product type of service, so that you can classify costs that are associated with the service

purchase to subcontracting activities. An indirect cost group can be assigned to indirect costs for surcharges

or rates. A cost group that is designated as undefined can be assigned to items, cost categories, or indirect

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/cost-groups.md
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costs. The assignment of a cost group type serves several purposes. First, it constrains the ability to assign a

cost group and to view a list of applicable cost groups. Second, it provides supplemental segmentation for

reporting purposes. Third, it can be used to assign ledger accounts for variances.

BehaviorBehavior  − Each cost group can optionally be assigned a behavior to indicate that the cost group applies to

fixed costs or variable costs. A cost group that has a null value for behavior is treated as a variable cost. The

assignment of a behavior serves only a reporting purpose. For example, costs can be displayed with

segmentation of fixed and variable costs on the costing sheet and on the Cost rollup by cost groupCost rollup by cost group page.

If you assign a profit setting percentage to each cost group, the bill of materials (BOM) calculation provides a

suggested sales price, based on a cost-plus-markup approach.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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FIFO without the Include physical value option

First in, First out (FIFO) is an inventory model in which the first acquired receipts are issued first. Financially

updated issues from inventory are settled against the first financially updated receipts into inventory, based on

the financial date of the inventory transaction.

When you use FIFO, you don’t have to use the FIFO rule. Instead, you can mark inventory transactions so that a

specific item receipt is settled against a specific issue. We recommend a periodic inventory closing when you

use the FIFO inventory model. The following examples show the effect of using FIFO in three configurations:

FIFO without the Include physical valueInclude physical value option

FIFO with the Include physical valueInclude physical value option

FIFO with marking

In this example, the item model group isn't marked to include physical value. The illustration that follows shows

these transactions:

1a. Inventory physical receipt for a quantity of 1 at a cost of USD 10.00 each.

1b. Inventory financial receipt for a quantity of 1 at a cost of USD 10.00 each.

2a. Inventory physical receipt for a quantity of 2 at a cost of USD 10.00 each.

2b. Inventory financial receipt for a quantity of 2 at a cost of USD 10.00 each.

3a. Inventory physical receipt for a quantity of 1 at a cost of USD 25.00 each.

4a. Inventory physical receipt for a quantity of 1 at a cost of USD 30.00 each.

4b. Inventory financial receipt for a quantity of 1 at a cost of USD 30.00 each.

5a. Inventory physical issue for a quantity of 1 at a cost price of USD 20.00 each (running average of

financially updated transactions).

5b. Inventory financial issue for a quantity of 1 at a cost price of USD 15.00 each (running average of

financially updated transactions).

6. Inventory close is performed. Based on the FIFO method, the first financially updated issue will be

settled against the first financially updated receipt. An adjustment of USD –5.00 will be made on the

issue transaction.

The new running average cost price reflects the average of the financially updated transactions. The following

illustrations shows the effects of the FIFO inventory model on this series of transactions when the IncludeInclude

physical valuephysical value option isn't used.

Key to the diagramKey to the diagram

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/fifo-physical-value-marking.md


FIFO with the Include physical value option

Inventory transactions are represented by vertical arrows.

Receipts into inventory are represented by vertical arrows above the timeline.

Issues out of inventory are represented by vertical arrows below the timeline.

Above (or below) each vertical arrow, the value of the inventory transaction is specified in the format

Quantity@Unitprice.

An inventory transaction value that is enclosed in parentheses indicates that the inventory transaction is

physically posted into inventory.

An inventory transaction value that isn't enclosed in parentheses indicates that the inventory transaction is

financially posted into inventory.

Each new receipt or issue transaction is designated by a new label.

Each vertical arrow is labeled with a sequential identifier, such as 1a. The identifiers indicate the order of

inventory transaction postings in the timeline.

Inventory closings are represented by a red vertical dashed line and the label Inventory Close.

Settlements that are performed by inventory close are represented by red diagonal dashed arrows that go

from a receipt to an issue.

If the Include physical valueInclude physical value check box is selected for an item on the Item model groupItem model group page, the system

uses both physical and financial receipt transactions to calculate the running average cost price. Where

applicable, the system also makes adjustments to the physically updated issue transaction. When the IncludeInclude

physical valuephysical value check box is cleared, inventory close with the FIFO inventory model makes settlements only to

transactions that are financially updated. The illustration that follows shows these transactions:

1a. Inventory physical receipt for a quantity of 1 at a cost of USD 10.00 each.

1b. Inventory financial receipt for a quantity of 1 at a cost of USD 10.00 each.

2a. Inventory physical receipt for a quantity of 1 at a cost of USD 20.00 each.

2b. Inventory financial receipt for a quantity of 1 at a cost of USD 20.00 each.

3a. Inventory physical receipt for a quantity of 1 at a cost of USD 25.00 each.

4a. Inventory physical receipt for a quantity of 1 at a cost of USD 30.00 each.

4b. Inventory financial receipt for a quantity of 1 at a cost of USD 30.00 each.

5a. Inventory physical issue for a quantity of 1 at a cost price of USD 21.25 each (running average of financial

and physical updated transactions).

5b. Inventory financial issue for a quantity of 1 at a cost price of USD 21.25 each (running average of

financial and physical updated transactions).

6a. Inventory physical issue for a quantity of 1 at a cost price of USD 21.25 each.

7. Inventory close is performed. Based on the FIFO method, the first financial issue transaction will be

adjusted or settled against the first updated receipt, either financial or physical.

Transaction 5b will be settled against receipt transaction 1b. There will be an adjustment of USD –11.25 to this

issue transaction. The new running average cost price reflects the average of the financially and physically

updated transactions, USD 27.50. The following illustration shows the effects of the FIFO inventory model on

this series of transactions when the Include physical valueInclude physical value option is used.



FIFO with marking

Key to the diagramKey to the diagram

Inventory transactions are represented by vertical arrows.

Receipts into inventory are represented by vertical arrows above the timeline.

Issues out of inventory are represented by vertical arrows below the timeline.

Above (or below) each vertical arrow, the value of the inventory transaction is specified in the format

Quantity@Unitprice.

An inventory transaction value that is enclosed in parentheses indicates that the inventory transaction is

physically posted into inventory.

An inventory transaction value that isn't enclosed in parentheses indicates that the inventory transaction is

financially posted into inventory.

Each new receipt or issue transaction is designated by a new label.

Each vertical arrow is labeled with a sequential identifier, such as 1a. The identifiers indicate the order of

inventory transaction postings in the timeline.

Inventory closings are represented by a red vertical dashed line and the label Inventory Close.

Settlements that are performed by inventory close are represented by red diagonal dashed arrows that go

from a receipt to an issue.

Marking is a process that lets you link, or mark, an issue transaction to a receipt transaction. Marking can occur

either before or after a transaction is posted. You can use marking when you want to be sure of the exact cost of

inventory when the transaction is posted or the inventory close is performed. For example, the Customer

Service department accepted a rush order from an important customer. Because this order is a rush order, you

must pay more for this item in order to fulfill your customer’s request. You must make sure that the cost of this

inventory item is reflected in the margin, or cost of goods sold (COGS), for this sales order invoice. When the

purchase order is posted, the inventory is received at a cost of USD 120.00. If this sales order document is

marked to the purchase order before the packing slip or invoice is posted, the COGS will be USD 120.00, not the

current running average cost for the item. If the sales order packing slip or invoice is posted before the marking

occurs, the COGS will be posted at the running average cost price. Before inventory close is performed, these

two transactions can still be marked to each other. When a receipt transaction matches an issue transaction, the

valuation method that is defined in the item model group is disregarded, and the system settles these

transactions to each other. You can mark an issue transaction to a receipt before the transaction is posted. You

can do this from a sales order line on the Sales order detailsSales order details  page. You can view the open receipt transactions

on the MarkingMarking page. You can also mark an issue transaction to a receipt after the transaction is posted. You can

match or mark an issue transaction for an open receipt transaction for an inventoried item from a posted

inventory adjustment journal. The illustration that follows shows these transactions:

1a. Inventory physical receipt for a quantity of 1 at a cost of USD 10.00 each.

1b. Inventory financial receipt for a quantity of 1 at a cost of USD 10.00 each.

2a. Inventory physical receipt for a quantity of 1 at a cost of USD 20.00 each.

2b. Inventory financial receipt for a quantity of 1 at a cost of USD 20.00 each.

3a. Inventory physical receipt for a quantity of 1 at a cost of USD 25.00 each.
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4a. Inventory physical receipt for a quantity of 1 at a cost of USD 30.00 each.

4b. Inventory financial receipt for a quantity of 1 at a cost of USD 30.00 each.

5a. Inventory physical issue for a quantity of 1 at a cost price of USD 21.25 each (running average of financial

and physical updated transactions).

5b. Inventory financial issue for a quantity of 1 is marked to inventory receipt 2b before the transaction is

posted. This transaction is posted at a cost price of USD 20.00 each.

6a. Inventory physical issue for a quantity of 1 at a cost price of USD 21.25 each.

7. Inventory close is performed. Because the financially updated FIFO transaction is marked to an

existing receipt, these transactions are settled against each other, and no adjustment is made.

The new running average cost price reflects the average of the financially and physically updated transactions,

USD 27.50. The following illustration shows the effects of the FIFO inventory model on this series of

transactions when marking between issues and receipts is used.

Key to the diagramKey to the diagram

Inventory transactions are represented by vertical arrows.

Receipts into inventory are represented by vertical arrows above the timeline.

Issues out of inventory are represented by vertical arrows below the timeline.

Above (or below) each vertical arrow, the value of the inventory transaction is specified in the format

Quantity@Unitprice.

An inventory transaction value that is enclosed in parentheses indicates that the inventory transaction is

physically posted into inventory.

An inventory transaction value that isn't enclosed in parentheses indicates that the inventory transaction is

financially posted into inventory.

Each new receipt or issue transaction is designated by a new label.

Each vertical arrow is labeled with a sequential identifier, such as 1a. The identifiers indicate the order of

inventory transaction postings in the timeline.

Inventory closings are represented by a red vertical dashed line and the label Inventory Close.

Settlements that are performed by inventory close are represented by red diagonal dashed arrows that go

from a receipt to an issue.
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VA L UEVA L UE RESULTRESULT

Selected Both physically updated transactions and financially updated
transactions are used to calculate the running average cost
price.

Cleared Only financially updated transactions are used to calculate
the running average cost price.

NOTENOTE

You use the Include physical value check box on the Inventory model FastTab of the Item model groups page to

specify whether physically updated transactions are considered when the running average cost price is

calculated for an item.

The Include physical valueInclude physical value check box has the following values.

The check box has slightly different effects, depending on the inventory model that you use.

If you select the Include physical valueInclude physical value check box when you use the FIFO (First in, first out), LIFO (Last in,

first out), or LIFO date inventory model, inventory close also makes adjustments to physically updated

transactions.

If you don't select the Include physical valueInclude physical value check box when you use these inventory models, inventory

close makes settlements only to financially updated transactions.

When you use the weighted average or weighted average date inventory model, inventory close settles only

financially updated transactions, regardless of whether you select the Include physical valueInclude physical value check box.

Example 1Example 1  You've selected the Include physical valueInclude physical value check box and receive the following purchase orders:

A purchase order for a quantity of 2 and a cost price of USD 10.00 that has been packing slip–updated.

A purchase order for a quantity of 3 and a cost price of USD 12.00 that has been invoice-updated.

In this case, the running average cost price will be USD 11.20 = (2x10+3x12)/(2+3), because both physically

updated transactions and financially updated transactions are used to calculate the cost price.

Example 2Example 2  You haven't selected the Include physical valueInclude physical value check box, and the cost price on the item setup is

USD 10.00.

You receive a purchase order for a quantity of 20 and a cost price of USD 12.00 that has been packing slip–

updated.

When a sales order is posted, the posted cost amount is USD 10.00, because the running average cost price

won't include physically posted transactions.

For comparison, if you select the Include physical valueInclude physical value check box for this item, when a sales order is posted, the

posted cost amount will be USD 12.00.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/include-physical-value.md


NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Inventory object values
2/18/2021 • 2 minutes to read • Edit Online

O B JEC T  T Y P EO B JEC T  T Y P E
IT EMIT EM
N UM B ERN UM B ER SIT ESIT E Q UA N T IT YQ UA N T IT Y

IN VEN TO RYIN VEN TO RY
UN ITUN IT VA L UEVA L UE

AVERA GEAVERA GE
UN IT  C O STUN IT  C O ST

Cost object A 1 150 Pcs.
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Inventory
object

A 1 11 B1 100 Pcs.

Inventory
object

A 1 11 B2 50 Pcs.

Additional resources

This article provides information about how the values of an inventory object are calculated.

A new functionality that is named physical quantityphysical quantity  lets you see the values of a specific inventory object.

A cost object represents the entity level where inventory accounting is performed. For more information about

cost objects, see Cost objects.

To see the values of a specific inventory object, click Physical quantityPhysical quantity  on the Cost objectCost object page. Here is how

the value of an inventory object is calculated:

Inventory object.Value = Cost object.Average unit cost × Inventory object.Quantity

The following example shows how the values of an inventory object and a cost object are calculated. Two

product receipt events are registered on item A:

Product receipt 1: Quantity = 100 pcs., Amount = $1,000.00, Site = 1, Warehouse =11, Batch No. = B1

Product receipt 2: Quantity = 50 pcs., Amount = $800.00, Site = 1, Warehouse =11, Batch No. = B2

The following table shows the calculation result for a cost object. You can view the result on the Cost objectCost object

page.

$1800.00 $12.00

The following table shows the calculation result for an inventory object. You can view the result by clicking

Physical quantityPhysical quantity  on the Cost objectCost object page.

$120
0.00

$12.0
0

$600.
00

$12.0
0

Cost objects

Cost entries

What's new and changed

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/physical-quantity.md
file:///T:/eiye/ac1a/dynamics365/fin-and-ops/get-started/whats-new-changed.html
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LIFO Date without the Include physical value option

Last in, First out Date (LIFO Date) is an inventory model based on the LIFO principle. Issues from inventory are

settled against the last receipts into inventory based on the date of the inventory transaction. By using LIFO

Date, if there is no receipt before the issue, the issue is settled against any receipts that occur after the date of

the issue. Several issues on the same date may be settled in the order of last issue, last receipt.

When you use the Last in, First out Date (LIFO Date) inventory model, if there is no receipt before the issue, the

issue is settled against any receipts that occur after the date of the issue. Several issues on the same date can be

settled in the order of last issue, last receipt. When you use LIFO Date, you don't have to use the LIFO Date rule.

Instead, you can mark inventory transactions so that a specific item receipt is settled against a specific issue.

We recommend a periodic inventory closing when you use the LIFO Date inventory model.

The following examples show the effect of using LIFO Date in three configurations:

LIFO Date without the Include physical valueInclude physical value option

LIFO Date with the Include physical valueInclude physical value option

LIFO Date with marking

In this example, the item model group isn't marked to include physical value. The illustration that follows shows

these transactions:

1a. Inventory physical receipt for a quantity of 1 at a cost of USD 10.00 each.

1b. Inventory financial receipt for a quantity of 1 at a cost of USD 10.00 each.

2a. Inventory physical receipt for a quantity of 1 at a cost of USD 20.00 each.

2b. Inventory financial receipt for a quantity of 1 at a cost of USD 20.00 each.

3a. Inventory physical receipt for a quantity of 1 at a cost of USD 25.00 each.

4a. Inventory physical issue for a quantity of 1 at a cost price of USD 15.00 (running average of financially

updated transactions).

4b. Inventory financial issue for a quantity of 1 at a cost price of USD 15.00 (running average of financially

updated transactions).

5a. Inventory physical receipt for a quantity of 1 at a cost of USD 30.00 each.

5b. Inventory financial receipt for a quantity of 1 at a cost of USD 30.00 each.

6. Inventory close is performed. Based on the LIFO Date method, the last financially updated issue will be

settled against the last financially updated receipt by date. An adjustment of USD 5.00 will be made on

the issue transaction. These transactions will be settled against each other.

The new running average cost price reflects the average of the financially updated transactions at USD 15.00.

The following illustration shows the effects of the LIFO Date inventory model when the Include physical valueInclude physical value

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/lifo-date-physical-value-marking.md


LIFO Date with the Include physical value option

option isn't used. 

Key to the diagramKey to the diagram

Inventory transactions are represented by vertical arrows.

Receipts into inventory are represented by vertical arrows above the timeline.

Issues out of inventory are represented by vertical arrows below the timeline.

Above (or below) each vertical arrow, the value of the inventory transaction is specified in the format

Quantity@Unitprice.

An inventory transaction value that is enclosed in parentheses indicates that the inventory transaction is

physically posted into inventory.

An inventory transaction value that isn't enclosed in parentheses indicates that the inventory transaction is

financially posted into inventory.

Each new receipt or issue transaction is designated by a new label.

Each vertical arrow is labeled with a sequential identifier, such as 1a. The identifiers indicate the order of

inventory transaction postings in the timeline.

Inventory closings are represented by a red vertical dashed line and the label Inventory Close.

Settlements that are performed by inventory close are represented by red diagonal dashed arrows that go

from a receipt to an issue.

You can select the Include physical valueInclude physical value check box for an item on the Item model groupsItem model groups  page. In this

case, the system uses both physical and financial receipt transactions to calculate the running average cost price.

Where applicable, the system also makes adjustments to the physically updated issue transaction. When the

Include physical valueInclude physical value check box is cleared, inventory close that uses the LIFO Date inventory model makes

settlements only to transactions that are financially updated.

In this example, the item model group is marked to include physical value.

The illustration that follows shows these transactions:

1a. Inventory physical receipt for a quantity of 1 at a cost of USD 10.00 each.

1b. Inventory financial receipt for a quantity of 1 at a cost of USD 10.00 each.

2a. Inventory physical receipt for a quantity of 1 at a cost of USD 20.00 each.

2b. Inventory financial receipt for a quantity of 1 at a cost of USD 20.00 each.

3a. Inventory physical receipt for a quantity of 1 at a cost of USD 25.00 each.

4a. Inventory physical issue for a quantity of 1 at a cost price of USD 18.33 each (running average of

financially updated transactions).

4b. Inventory financial issue for a quantity of 1 at a cost price USD 18.33 each (running average of financially

updated transactions).

5a. Inventory physical receipt for a quantity of 1 at a cost of USD 30.00 each.

5b. Inventory financial receipt for a quantity of 1 at a cost of USD 30.00 each.

6. Inventory close is performed. Based on the LIFO Date method, the last updated issue will be adjusted

or settled against the last updated receipt by date. These transactions will not be settled by each other,



LIFO Date with marking

because the financial receipt transaction is adjusted to a physical update transaction. Instead, only an

adjustment of USD 6.67 will be made on the issue transaction.

The new running average cost price reflects the average of the financially updated transactions at USD 20.00.

The following illustration shows the effects of the LIFO inventory model when the Include physical valueInclude physical value

option is used. 

Key to the diagramKey to the diagram

Inventory transactions are represented by vertical arrows.

Receipts into inventory are represented by vertical arrows above the timeline.

Issues out of inventory are represented by vertical arrows below the timeline.

Above (or below) each vertical arrow, the value of the inventory transaction is specified in the format

Quantity@Unitprice.

An inventory transaction value that is enclosed in parentheses indicates that the inventory transaction is

physically posted into inventory.

An inventory transaction value that isn't enclosed in parentheses indicates that the inventory transaction is

financially posted into inventory.

Each new receipt or issue transaction is designated by a new label.

Each vertical arrow is labeled with a sequential identifier, such as 1a. The identifiers indicate the order of

inventory transaction postings in the timeline.

Inventory closings are represented by a red vertical dashed line and the label Inventory Close.

Settlements that are performed by inventory close are represented by red diagonal dashed arrows that go

from a receipt to an issue.

Marking is a process that lets you link, or mark, an issue transaction to a receipt transaction. Marking can occur

either before or after a transaction is posted. You can use marking when you want to be sure of the exact cost of

inventory when the transaction is posted or the inventory close is performed.

For example, the Customer Service department accepted a rush order from an important customer. Because this

order is a rush order, you will have to pay more for this item in order to fulfill your customer’s request. You must

make sure that the cost of this inventory item is reflected in the margin, or cost of goods sold (COGS), for this

sales order invoice.

When the purchase order is posted, the inventory is received at a cost of USD 120.00. If this sales order

document is marked to the purchase order before the packing slip or invoice is posted, the COGS will be USD

120.00, not the current running average cost for the item. If the sales order packing slip or invoice is posted

before the marking occurs, the COGS will be posted at the running average cost price.

Before inventory close is performed, these two transactions can still be marked to each other.

For example, a receipt transaction is marked for an issue transaction. In this case, the valuation method that is

defined in the item’s item model group is disregarded, and the system settles these transactions against each

other.



You can mark an issue transaction to a receipt before the transaction is posted. You can do this from a sales

order line on the Sales order detailsSales order details  page. You can view the open receipt transactions on the MarkingMarking page.

You can also mark an issue transaction to a receipt after the transaction is posted. You can match or mark an

issue transaction for an open receipt transaction for an inventoried item from a posted inventory adjustment

journal.

The illustration that follows shows these transactions:

1a. Inventory physical receipt for a quantity of 1 at a cost of USD 10.00 each.

1b. Inventory financial receipt for a quantity of 1 at a cost of USD 10.00 each.

2a. Inventory physical receipt for a quantity of 1 at a cost of USD 20.00 each.

2b. Inventory financial receipt for a quantity of 1 at a cost of USD 20.00 each.

3a. Inventory physical receipt for a quantity of 1 at a cost of USD 25.00 each.

4a. Inventory physical receipt for a quantity of 1 at a cost of USD 30.00 each.

4b. Inventory financial receipt for a quantity of 1 at a cost of USD 30.00 each.

5a. Inventory physical issue for a quantity of 1 at a cost price of USD 21.25 each (running average of financial

and physical updated transactions).

5b. Inventory financial issue for a quantity of 1 is marked to inventory receipt 2b before the transaction is

posted. This transaction is posted with a cost price of USD 20.00 each.

6a. Inventory physical issue for a quantity of 1 at a cost price of USD 21.25 each.

7. Inventory close is performed. Because the financially updated First in, First out (FIFO) transaction is

marked to an existing receipt, these transactions are settled to each other, and no adjustment is made.

The new running average cost price reflects the average of the financially and physically updated transactions at

USD 27.50.

The following illustration shows the effects of the LIFO inventory model when marking between issues and

receipts is used. 

Key to the diagramKey to the diagram

Inventory transactions are represented by vertical arrows.

Receipts into inventory are represented by vertical arrows above the timeline.

Issues out of inventory are represented by vertical arrows below the timeline.

Above (or below) each vertical arrow, the value of the inventory transaction is specified in the format

Quantity@Unitprice.

An inventory transaction value that is enclosed in parentheses indicates that the inventory transaction is

physically posted into inventory.

An inventory transaction value that isn't enclosed in parentheses indicates that the inventory transaction is

financially posted into inventory.

Each new receipt or issue transaction is designated by a new label.

Each vertical arrow is labeled with a sequential identifier, such as 1a. The identifiers indicate the order of

inventory transaction postings in the timeline.

Inventory closings are represented by a red vertical dashed line and the label Inventory Close.



NOTENOTE

Settlements that are performed by inventory close are represented by red diagonal dashed arrows that go

from a receipt to an issue.
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LIFO without the Include physical value option

Last in, First out (LIFO) is an inventory model in which the last (newest) receipts are issued first. Issues from

inventory are settled against the last receipts into inventory based on the date of the inventory transaction.

In the Last in, First out (LIFO) inventory model, the last (newest) receipts are issued first. Issues from inventory

are settled against the last receipts into inventory, based on the date of the inventory transaction. When you use

LIFO, you don't have to use the LIFO rule. Instead you can mark inventory transactions so that a specific item

issue is settled against a specific receipt. We recommend a periodic inventory closing when you use the LIFO

inventory model.

The following examples show the effect of using LIFO in three configurations:

LIFO without the Include physical valueInclude physical value option

LIFO with the Include physical valueInclude physical value option

LIFO with marking

In this example, the item model group isn't marked to include physical value. The illustration that follows shows

these transactions:

1a. Inventory physical receipt for a quantity of 1 at a cost of USD 10.00 each.

1b. Inventory financial receipt for a quantity of 1 at a cost of USD 10.00 each.

2a. Inventory physical receipt for a quantity of 1 at a cost of USD 20.00 each.

2b. Inventory financial receipt for a quantity of 1 at a cost of USD 20.00 each.

3a. Inventory physical receipt for a quantity of 1 at a cost of USD 25.00 each.

4a. Inventory physical receipt for a quantity of 1 at a cost of USD 30.00 each.

4b. Inventory financial receipt for a quantity of 1 at a cost of USD 30.00 each.

5a. Inventory physical issue for a quantity of 1 at a cost price of USD 20.00 each (running average of

financially updated transactions).

5b. Inventory financial issue for a quantity of 1 at a cost price of USD 20.00 each (running average of

financially updated transactions).

6. Inventory close is performed. Based on the LIFO method, the last financially updated issue will be

settled against the last financially updated receipt. An adjustment of USD 10.00 will be made on the

issue transaction.

The new running average cost price reflects the average of the financially updated transactions, USD 15.00. The

following illustration shows the effects of the LIFO inventory model on this series of transactions when the

Include physical valueInclude physical value option isn't used.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/lifo-physical-value-marking.md


LIFO with the Include physical value option

Key to the diagramKey to the diagram

Inventory transactions are represented by vertical arrows.

Receipts into inventory are represented by vertical arrows above the timeline.

Issues out of inventory are represented by vertical arrows below the timeline.

Above (or below) each vertical arrow, the value of the inventory transaction is specified in the format

Quantity@Unit price.

An inventory transaction value that is enclosed in parentheses indicates that the inventory transaction is

physically posted into inventory.

An inventory transaction value that isn't enclosed in parentheses indicates that the inventory transaction is

financially posted into inventory.

Each new receipt or issue transaction is designated by a new label.

Each vertical arrow is labeled with a sequential identifier, such as 1a. The identifiers indicate the order of

inventory transaction postings in the timeline.

Inventory closings are represented by a red vertical dashed line and the label Inventory Close.

Settlements that are performed by inventory close are represented by red diagonal dashed arrows that go

from a receipt to an issue.

If the Include physical valueInclude physical value check box is selected for an item on the Item model groupsItem model groups  page, the system

uses both physical and financial receipt transactions to calculate the running average cost price. Where

applicable, the system also makes adjustments to the physically updated issue transaction. When the IncludeInclude

physical valuephysical value check box is cleared, inventory close with the LIFO inventory model makes settlements only to

transactions that are financially updated.

The illustration that follows shows these transactions:

1a. Inventory physical receipt for a quantity of 1 at a cost of USD 10.00 each.

1b. Inventory financial receipt for a quantity of 1 at a cost of USD 10.00 each.

2a. Inventory physical receipt for a quantity of 1 at a cost of USD 20.00 each.

2b. Inventory financial receipt for a quantity of 1 at a cost of USD 20.00 each.

3a. Inventory physical receipt for a quantity of 1 at a cost of USD 25.00 each.

4a. Inventory physical receipt for a quantity of 1 at a cost of USD 30.00 each.

4b. Inventory financial receipt for a quantity of 1 at a cost of USD 30.00 each.

5a. Inventory physical issue for a quantity of 1 at a cost price of USD 21.25 each (running average of financial

and physical updated transactions).

5b. Inventory financial issue for a quantity of 1 at a cost price of USD 21.25 each (running average of

financial and physical updated transactions).

6a. Inventory physical issue for a quantity of 1 at a cost price of USD 21.25 each.

7. Inventory close is performed. Based on the LIFO method, the last issue transaction will be adjusted or

settled against the last updated receipt.

Transaction 6a will be adjusted to receipt transaction 4b. The system won't settle these transactions, because the

receipt is updated physically but not financially. Instead, only an adjustment of USD 8.75 will be posted to the

physical issue transaction. Transaction 5b will be adjusted to physical receipt transaction 3a. The system won't

settle these transactions, because they aren't both financially updated. Instead, only an adjustment of USD –3.75

will be made to this issue transaction. The new running average cost price reflects the average of the financially

and physically updated transactions, USD 20.00.

The following illustration shows the effects of the LIFO inventory model on this series of transactions when the

Include physical valueInclude physical value option is used.



LIFO with marking

Key to the diagramKey to the diagram

Inventory transactions are represented by vertical arrows.

Receipts into inventory are represented by vertical arrows above the timeline.

Issues out of inventory are represented by vertical arrows below the timeline.

Above (or below) each vertical arrow, the value of the inventory transaction is specified in the format

Quantity@Unit price.

An inventory transaction value that is enclosed in parentheses indicates that the inventory transaction is

physically posted into inventory.

An inventory transaction value that isn't enclosed in parentheses indicates that the inventory transaction is

financially posted into inventory.

Each new receipt or issue transaction is designated by a new label.

Each vertical arrow is labeled with a sequential identifier, such as 1a. The identifiers indicate the order of

inventory transaction postings in the timeline.

Inventory closings are represented by a red vertical dashed line and the label Inventory Close.

Settlements that are performed by inventory close are represented by red diagonal dashed arrows that go

from a receipt to an issue.

Marking is process that lets you link, or mark, an issue transaction to a receipt transaction. Marking can occur

either before or after a transaction is posted. You can use marking when you want to be sure of the exact cost of

inventory when the transaction is posted or the inventory close is performed. For example, the Customer

Service department accepted a rush order from an important customer. Because this order is a rush order, you

must pay more for this item in order to fulfill your customer’s request.

You must make sure that the cost of this inventory item is reflected in the margin, or cost of goods sold (COGS),

for this sales order invoice. When the purchase order is posted, the inventory is received at a cost of USD

120.00. If this sales order document is marked to the purchase order before the packing slip or invoice is posted,

the COGS will be USD 120.00, not the current running average cost for the item. If the sales order packing slip

or invoice is posted before the marking occurs, the COGS will be posted at the running average cost price.

Before inventory close is performed, these two transactions can still be marked to each other.

You can mark an issue transaction to a receipt before the transaction is posted. You can do this from a sales

order line on the Sales order detailsSales order details  page. You can view the open receipt transactions on the MarkingMarking page.

You can also mark an issue transaction to a receipt after the transaction is posted. You can match or mark an

issue transaction for an open receipt transaction for an inventoried item from a posted inventory adjustment

journal.

The illustration that follows shows these transactions:

1a. Inventory physical receipt for a quantity of 1 at a cost of USD 10.00 each.

1b. Inventory financial receipt for a quantity of 1 at a cost of USD 10.00 each.



NOTENOTE

2a. Inventory physical receipt for a quantity of 1 at a cost of USD 20.00 each.

2b. Inventory financial receipt for a quantity of 1 at a cost of USD 20.00 each.

3a. Inventory physical receipt for a quantity of 1 at a cost of USD 25.00 each.

4a. Inventory physical receipt for a quantity of 1 at a cost of USD 30.00 each.

4b. Inventory financial receipt for a quantity of 1 at a cost of USD 30.00 each.

5a. Inventory physical issue for a quantity of 1 at a cost price of USD 21.25 each (running average of financial

and physical updated transactions).

5b. Inventory financial issue for a quantity of 1 is marked to inventory receipt 2b before the transaction is

posted. This transaction is posted with a cost price of USD 20.00 each.

6a. Inventory physical issue for a quantity of 1 at a cost price of USD 21.25 each.

7. Inventory close is performed. Because the financially updated FIFO transaction is marked to an

existing receipt, these transactions are settled against each other, and no adjustment is made.

The new running average cost price reflects the average of the financially and physically updated transactions,

USD 27.50.

The following illustration shows the effects of the LIFO inventory model on this series of transactions when

marking between issues and receipts is used.

Key to diagramKey to diagram

Inventory transactions are represented by vertical arrows.

Receipts into inventory are represented by vertical arrows above the timeline.

Issues out of inventory are represented by vertical arrows below the timeline.

Above (or below) each vertical arrow, the value of the inventory transaction is specified in the format

Quantity@Unit price.

An inventory transaction value that is enclosed in parentheses indicates that the inventory transaction is

physically posted into inventory.

An inventory transaction value that isn't enclosed in parentheses indicates that the inventory transaction is

financially posted into inventory.

Each new receipt or issue transaction is designated by a new label.

Each vertical arrow is labeled with a sequential identifier, such as 1a. The identifiers indicate the order of

inventory transaction postings in the timeline.

Inventory closings are represented by a red vertical dashed line and the label Inventory Close.

Settlements that are performed by inventory close are represented by red diagonal dashed arrows that go

from a receipt to an issue.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Convert to the moving average costing method

Moving average is a perpetual costing method based on the average principle, where the costs on inventory

issues do not change when the purchase cost does. The difference is capitalized and is based on a proportional

calculation. The amount that remains is expensed.

When you use moving average, inventory settlements and inventory marking are not supported. Inventory

close does not affect products that have moving average as the inventory model group, and it does not generate

any settlements between the transactions.

The following are prerequisites when you use moving average cost as a costing method.

NOTENOTE

NOTENOTE

1. On the Item model groupsItem model groups  page, set up an item model group that has Moving averageMoving average selected in

the Inventor y modelInventor y model  field.

By default, when Moving averageMoving average is selected, the Post physical inventor yPost physical inventor y  and Post financial inventor yPost financial inventor y

fields are also selected.

2. On the PostingPosting page, assign accounts to the Pr ice difference for moving averagePrice difference for moving average. You use the Pr icePrice

difference for moving averagedifference for moving average account when cost has to be proportionally expensed. This occurs in

following two scenarios:

There is a difference in cost between a purchase receipt and the purchase invoice because there is a

difference between the original inventory quantity and the current on-hand quantity.

The transactions bring the inventory from negative to zero, and there is a difference between the

transaction cost and the current moving average cost.

3. On the PostingPosting page, assign accounts to the Cost revaluation for moving averageCost revaluation for moving average accounts on the

Inventor yInventor y  tab. You use the Cost revaluation for moving averageCost revaluation for moving average account when you want to adjust

the moving average cost for a product to a new unit price.

4. On the Released productsReleased products  page, assign the moving average item model group to the product.

The inventory close process only closes the accounting period. It does not affect products that have moving

average assigned to them as an item model group.

Products can be converted to use the moving average inventory valuation method. This type of conversion is

usually done at the end of the year, after the last month of the current year is closed. It is done by using the

product’s current costing model. You can change your inventory costing method from a costing method that is

based on average cost or standard cost to a method that is based on moving average.

If you are changing your costing method from a standard costing method to a moving average method, you

have to complete the following tasks:

1. Make adjustments to get inventory quantities and values down to 0 (zero).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/moving-average.md


NOTENOTE

Purchase order and proportionally expensed cost difference

Moving average product and inventory adjustment

NOTENOTE

2. After the inventory value and quantity are 0 (zero), change the item model group to moving average.

3. Make adjustments to get the quantity and value back into inventory.

You cannot change your inventory costing method from a moving average method to a First in, First out (FIFO)

method, a Last in, First out (LIFO) method, or a weighted average method.

Converting from standard cost to moving weighted average is a manual process.

The following examples illustrate the effect of using the moving average costing method. There are four

configurations:

Purchase order and proportionally expensed cost difference

Moving average product and inventory adjustment

Moving average with production

Moving average with a backdated transaction

With moving average, the product’s cost is determined by the purchase receipt. When the purchase invoice is

posted, if there is a difference in cost between the purchase receipt and the purchase invoice, the difference is

proportionally adjusted to the current products in stock, and any remaining amount is expensed.

In this example, a purchase order is created and received at one cost, and the purchase invoice is posted with a

different cost.

1. Create a purchase order for a quantity of 2 and a unit price of 10.00.

2. Create a purchase receipt of the product.

3. Create a sales order for a quantity of 1 and a unit price of 10.00.

4. Create a purchase invoice for a quantity of 2 and a unit price of 12.00.

The difference in unit price, 2.00, is posted to the Price difference for moving average account when the

purchase invoice is posted. The reason is that two products were purchased for a cost of 20.00. One of the

products was sold for a unit price of 10.00. The purchase invoice was posted at a unit price of 12.00 with a

quantity of 2. The unit price of the product cannot be posted at 14.00.

If you need to adjust the moving average cost of a product, inventory adjustments are allowed as of today’s

date. You cannot backdate an inventory adjustment to correct the moving average cost of a product. You cannot

have the cost flow through subsequent transactions.

In this example, the moving average cost is adjusted for a product.

1. Select the product that you want to adjust the moving average cost for.

The Revaluation for moving averageRevaluation for moving average page examines the inventory available for a product. The product selected has a

posted quantity of 1, a posted a value of 12.00, a posted unit cost of 12.00, and a unit cost of 12.00.

1. Update the Unit costUnit cost field to 16.00. The system calculates the remaining fields.

2. The adjustment is posted.



NOTENOTE

Moving average with production

Moving average with a backdated transaction

Negative inventory balances

New balance is negative or zeroNew balance is negative or zero

New balance is positiveNew balance is positive

PA RTPA RT DESC RIP T IO NDESC RIP T IO N

Quantity from negative to zero Inventory uses the current moving average cost of the item
rather than the transaction cost for that portion of the
receipt quantity that increases the on-hand balance from
negative to zero. The difference between the transaction cost
and the current moving average cost is posted to PricePrice
difference for moving averagedifference for moving average.

You can only adjust the moving average cost as of today’s date.

On the Settlements for voucherSettlements for voucher  page, you can see an adjustment of 4.00 posted to the Cost revaluation for

moving average account.

Moving average supports produced items. If you plan to use moving average in a production environment,

select Use estimated cost pr iceUse estimated cost pr ice on the Production control parametersProduction control parameters  page. This means that the cost

price that is calculated during estimation is used instead of the actual BOM calculation cost price.

Backdated transactions are assigned the current moving average cost, and the product’s physical quantity is

updated, but the product’s moving average cost is not affected. In this moving average example, a backdated

transaction for a moving average product is posted.

1. Create an inventory adjustment for the moving average product for a quantity of 1 and a cost of 20.00.

2. The inventory transaction history for the product would resemble the following:

3. Post the adjustment.

An inventory transaction of 1, a cost of 16.00, a posting date of January 15, and a transaction date of

January 15.

An inventory adjustment of 1, a cost of 20.00, a posting date of January 1, and a transaction date of

January 15.

On the Inventor y transactionsInventor y transactions  page, you can see that 4.00 is expensed as the current moving average for the

product is 16.00. You can post in the past, but the difference in cost is expensed, so the moving average cost is

not affected.

Transactions are handled differently depending on whether the new on-hand quantity after the transaction is

negative, zero, or positive.

If the new on-hand quantity is negative or zero, the transaction is costed at the current average costs. If there is a

difference between the purchase price and the current average costs, it's posted to Pr ice difference forPr ice difference for

moving averagemoving average.

If the new on-hand quantity is positive after the transaction, the transaction is split into two parts and costed

differently, as summarized in the following table.



Quantity from zero to positive Inventory uses the transaction cost for that portion of the
receipt quantity that increases the on-hand balance from
zero to positive.

PA RTPA RT DESC RIP T IO NDESC RIP T IO N

Inventory value report

T RA N SA C T IO NT RA N SA C T IO N
T IM ET IM E DAT EDAT E

T RA N SA C T IO NT RA N SA C T IO N
T Y P ET Y P E Q UA N T IT YQ UA N T IT Y A M O UN TA M O UN T

AVERA GE UN ITAVERA GE UN IT
C O STC O ST

October 1 Beginning
balance

0 0.00 0.00

October 8 September 28 Backdated
receipt

1 16.00 16.00

October 3 October 3 Purchase receipt 2 20.00 12.00

October 5 October 5 Sales order -1 -10.00 13.00

October 7 October 7 Purchase invoice 2.00 14.00

October 8 October 8 Moving average
revaluation

4.00 16.00

October 31 Total 2 32.00 16.00

NOTENOTE

NOTENOTE

In this moving average example, the inventory value report is printed to support the current moving average

calculation for a product. The Inventory value report can print the transactions in chronological order, together

with the cost to support the moving average cost calculation of a product. The report displays the moving

average cost for the product. In the Inventor y value repor tsInventor y value repor ts  dialog box, a date interval allows you to select

the Transaction timeTransaction time or the Posting datePosting date to sort the report by. The Posting datePosting date option is how the report is

traditionally printed. The Transaction timeTransaction time option is the actual date that the transaction is reported and the

moving average cost for the product is updated. You can print the Inventory value report by using the

Transaction time sor tingTransaction time sor ting option if you want to see the moving average cost calculation over time. The

following table displays the transactions for the product that the report is printed for when the TransactionTransaction

time sor tingtime sor ting option is used.

You cannot reconcile the general ledger with inventory by using the Transaction time sor tingTransaction time sor ting option. The report must

be printed by using the Posting datePosting date option.
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NOTENOTE

One way that you can calculate the cost of your inventory is by using a moving average. Up to three cost values

can be associated with each inventory item:

Last issueLast issue – The last issue cost that was assigned before inventory went negative

Active costActive cost – The latest cost that was activated in a costing version

Item priceItem price – The cost that is specified for the released product

To determine which of these cost values should be used in moving average calculations, the system uses a

fallback cost sequence to establish the order of preference for the values. If the preferred cost value isn't

available, the system uses the next-preferred value, and so on.

In previous versions of Microsoft Dynamics 365 Supply Chain Management, the system used a fixed fallback

cost sequence (Last issue – Active cost – Item price). In version 10.0.11, this sequence is still the default

sequence. However, you can also turn on a feature that lets you select among three available fallback cost

sequences. This feature can be especially useful for organizations that regularly use negative inventory values.

To make the selector for the fallback cost sequence available, you (or an admin) must use Feature management

to turn on the feature that is named Moving average fallback cost sequence.

To select the fallback cost sequence for moving average calculations, follow these steps.

1. Open the ParametersParameters  page.

2. On the Inventor y accountingInventor y accounting tab, in the Moving averageMoving average section, set the Fallback cost sequenceFallback cost sequence

field to one of the following values:

Last issue – Active cost – Item priceLast issue – Active cost – Item price – This sequence is the default sequence. It's the same

sequence that is used if the Moving average fallback cost sequence feature isn't turned on.

Active cost – Last issueActive cost – Last issue

Active cost – Item priceActive cost – Item price – Organizations might experience performance issues if they use business

processes where inventory regularly goes negative and, at the same time, the transaction volume is

high. This setting can help mitigate those performance issues.
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Physical increases

Financial increases

Transactions that increase quantity

Transactions that decrease quantity

NOTENOTE

Physical issues vs. financial issues

This topic provides an overview of which types of transactions increase or decrease inventory quantities.

Inventory transactions can be physically updated and financially updated in Dynamics 365 Supply Chain

Management. Some types of physical and financial transactions increase inventory quantities, whereas others

decrease the quantity.

When a physical transaction is posted, the status of the transaction record is ReceivedReceived. The following

transactions are considered physical increases:

Purchase order receipt

Sales order packing slip return

Reporting a production order as finished

By-product on a production order picking list

When a financial receipt transaction is posted, the status of the transaction record that increases the quantity is

PurchasedPurchased. The following transactions are considered financial increases:

Vendor invoice

Sales order invoice for a return

Production order costing

Positive quantity inventory journals, such as movement, profit and loss, counting, bill of materials, and

transfer

Transactions that increase quantity are posted at the running average cost price. The calculated running average

cost price is based on the cost of each of these transactions for each inventory dimension that is being tracked

financially. For information about running average cost prices, see Running average cost price.

The calculated running average cost price is used when a transaction that decreases quantity is posted,

regardless of the inventory model that is associated with that inventory. The transaction that decreases quantity

must not have been marked to another transaction before it was posted. If the physical on-hand inventory

becomes negative, the inventory cost that is defined for the item on the ItemItem page is used.

If multisite functionality is enabled, this cost will instead be the inventory cost that is defined for a site on the DefaultDefault

order settingsorder settings page.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/physical-financial-updates.md
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When a physical issue transaction is posted, the status of the transaction record is DeductedDeducted. The following

transactions are considered physical issues:

Production order picking list journal

Sales order packing slip

Purchase order packing slip return

When a financial transaction is posted, the status of the transaction record is SoldSold. The following transactions

are considered financial issues:

Ending a production order

Sales order invoice

Vendor invoice return

Negative quantity inventory journals, such as movement, profit and loss, counting, bill of materials, and

transfer

Transactions that decrease quantity are posted at the running average cost price. Therefore, the inventory close

procedure is required in order to settle issue transactions to receipt transactions, based on the inventory model

that is assigned to each item.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Using the running average cost price

C O N DIT IO NC O N DIT IO N
T H E SY ST EM  USES T H E EST IM AT EDT H E SY ST EM  USES T H E EST IM AT ED
RUN N IN G AVERA GE C O ST  P RIC ERUN N IN G AVERA GE C O ST  P RIC E

T H E SY ST EM  USES T H E C O ST  P RIC ET H E SY ST EM  USES T H E C O ST  P RIC E
T H AT  IS DEF IN ED O N  T H E IT EMT H AT  IS DEF IN ED O N  T H E IT EM
M A ST ERM A ST ER

Both the numerator* and
denominator** are positive.

Yes No

The numerator*, denominator**, or
both are negative.

No Yes

The denominator** is 0 (zero). No Yes

Avoiding pricing amplification

The inventory close process settles issue transactions to receipt transactions, based on the inventory valuation

method that is selected in the item’s item model group. However, before inventory close is run, the system

calculates a running average cost price that is typically used when issue transactions are posted.

The system estimates this running average cost price for an item by using the following formula:

Estimated price = (Physical amount + Financial amount) ÷ (Physical quantity + Financial quantity)

The following table shows when the system posts inventory transactions by using the running average cost

price, and when it uses the cost price that is defined on the item master record instead.

* Numerator = (Physical amount + Financial amount) ** Denominator = (Physical quantity + Financial quantity)

Note:Note: If the Include physical valueInclude physical value option isn't selected for an item, the system uses 0 (zero) for both the

physical amount and the physical quantity. For information about this option, see Include physical value.

On rare occasions, the system prices several issues before it has enough receipts to base the price on. This

scenario can cause estimates of the running average cost price to be overly inflated. However, there are steps

that you can take to avoid pricing amplification, or to reduce its impact when it does occur. ScenarioScenario The

following transactions occur for an item that you've selected the Include physical valueInclude physical value option for :

1. You financially receive a quantity of 100 at USD 100.00.

2. You financially issue a quantity of 200.

3. You physically receive a quantity of 101 at USD 202.00.

When you examine the estimated running average cost price for the item, you expect a cost price of USD 1.51.

Instead, you find an estimated running average of USD 102.00, which is based on the following formula:

Estimated price = [202 + (-100)] ÷ [101 + (-100)] = 102 ÷ 1 = 102 This pricing amplification occurs because,

when 200 items are issued financially in step 2, the system must price 100 of the items before it has any

corresponding receipts. This situation causes negative inventory. The system then estimates a unit price of USD

1.00, as we might expect. However, when the corresponding 100 receipts arrive, they are at a unit price of USD

2.00 each.

Note:Note: Although the issues create negative inventory, inventory is positive when the issue price is calculated.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/running-average-cost-price.md
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Therefore, the running average cost price is used instead of the price on the item master. At this point, the

system has an inventory value offset of USD 100.00. Although that offset was built up over 100 pieces, where

there was a unit offset of USD 1.00 each, we now have only one piece in inventory. Therefore, the offset of USD

100.00 is allocated to this one piece. The result is the overly inflated estimated cost price.

Note:Note: For comparison, notice that if steps 2 and 3 are reversed in the scenario, 200 items will be issued at a unit

price of USD 1.51, and one piece will remain at a unit price of USD 1.51. Because this pricing amplification

scenario can occur when negative inventory is involved, it's difficult to avoid in the following cases:

You must estimate issue prices on the on-hand value and quantity.

You must adjust the on-hand value and quantity on issues and receipts.

Your business model allows you to send out, or price, more pieces than you have.

You must accept any receipt value and quantity that are submitted to you.

However, if your business model allows for the following practices, they can help you avoid the negative

quantities that make the pricing amplification scenario possible:

If you select the Include physical valueInclude physical value option for an item, clear the Physical negative inventor yPhysical negative inventor y  check

box on the Item model groupsItem model groups  page.

If you do not select the Include physical valueInclude physical value option for an item, clear the Financial negativeFinancial negative

inventor yinventor y  option on the Item model groupsItem model groups  page.

Additionally, consider that the maximum offset in your physical inventory value is limited by the number of

physical transactions, and the difference between physical and financial prices. Provided that all physical

transactions are eventually updated financially, the physical value can't rise to extreme levels. Finally, note that

the amplification effect decreases significantly when the accumulated offset is spread out over several on-hand

pieces instead of just one.

Can you tell us about your documentation language preferences? Take a short survey.
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NOTENOTE

An inventory dimension group is attached to every inventory item. Therefore, the running average cost price of

an item is calculated based on the selected inventory dimensions that are being tracked financially.

There are three types of inventory dimensions: product, storage, and tracking. Product dimensions include

configuration, size, and color. Product dimensions are always tracked financially. Storage and tracking

dimensions include site, warehouse, location, inventory status, license plate, batch number, and serial number.

You can decide which storage and tracking dimensions are tracked financially.

Example 1Example 1

If the storage dimension group that is attached to the item is financially tracked by warehouse, the running

average cost price is calculated per warehouse. The following purchase orders have been invoiced:

A purchase order for a quantity of 2 at a cost price of USD 10.00 has been invoiced for warehouse GW.

A purchase order for a quantity of 3 at a cost price of USD 12.00 has been invoiced for warehouse GW.

A purchase order for a quantity of 5 at a cost price of USD 15.00 has been invoiced for warehouse MW.

The running average cost price for warehouse GW is USD 11.20, and the running average cost price for

warehouse MW is USD 15.00. A sales order invoice is posted for warehouse GW. The value of the inventory and

the cost of goods sold (before inventory close is run and without marking) is USD 11.20. Another sales order is

posted for warehouse MW. The value of the inventory and the cost of goods sold (before inventory close is run

and without marking) is USD 15.00.

Example 2Example 2  If the storage dimension group that is attached to the item is financially tracked by warehouse, and

the tracking dimension group is financially tracked by batch number, the running average cost price is calculated

for each batch.

Note:Note: We recommend that you always view the cost price for all financial dimensions that are being tracked.

The following purchase orders have been invoiced:

A purchase order for a quantity of 2 at a cost price of USD 10.00 has been invoiced for warehouse GW and

batch AAA.

A purchase order for a quantity of 3 at a cost price of USD 12.00 has been invoiced for warehouse GW and

batch AAA.

A purchase order for a quantity of 2 at a cost price of USD 15.00 has been invoiced for warehouse GW and

batch BBB.

The running average cost price for warehouse GW and batch AAA is USD 11.20, and the running average cost

price for warehouse GW and batch BBB is USD 15.00.
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Weighted average date is an inventory model that is based on the weighted average principle. For the weighted

average principle, issues from inventory are valued at the average value of the items that are received into

inventory for each day in the inventory closing period.

When you run an inventory closing by using weighted average date, all daily receipts are settled against a

virtual issue. This virtual issue holds the total received quantity and value for that day. The virtual issue has a

corresponding virtual receipt that the issues will be settled against. Therefore, all issues receive the same

average cost. The virtual issue and virtual receipt can be considered a virtual transfer that is known as the

weighted average inventory closing transfer.

If only one receipt has occurred on or before the date, you don't have to value the average. Because all issues are

settled from that receipt, the virtual transfer won't be created. Likewise, if only issues occur on the date, there are

no receipts to value the average from, and the virtual transfer won't be created. When you use weighted average

date, you can mark inventory transactions so that a specific item receipt is settled against a specific issue. In this

case, you don't use the weighted average date rule. We recommend a monthly inventory closing when you use

the weighted average date inventory model.

The following formula is used to calculate the weighted average date costing method:

Weighted average = ([Q1 × P1] + [Q2 × P2] + [Qn × Pn]) ÷ (Q1 + Q2 + Qn)

During inventory close, the calculation is performed every day through the closing period, as shown in the

following illustration.

Inventory transactions that leave the inventory, such as sales orders, inventory journals, and production orders,

occur at an estimated cost price on the date of posting. This estimated cost price is also referred to as the

running average cost price. On the date of inventory close, the system analyzes the inventory transactions for

previous periods, previous days, and the current day. This analysis is used to determine which of the following

closing principles should be used:

Direct settlement

Summarized settlement

Settlements are inventory close postings that adjust the issues to the correct weighted average as of the closing

date.

Note:Note: For more information about settlements, see the article about inventory close. The following examples

illustrate the effect of using weighted average with five configurations:

Weighted average date direct settlement when the Include physical valueInclude physical value option isn't used

Weighted average date summarized settlement when the Include physical valueInclude physical value option isn't used

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/weighted-average-date.md


Weighted average date direct settlement when the Include physical
value option isn't used

Weighted average date direct settlement when the Include physical valueInclude physical value option is used

Weighted average date summarized settlement when the Include physical valueInclude physical value option is used

Weighted average date when marking is used

The current version uses the same direct settlement principle that was used for weighted average in earlier

versions. The system settles directly between receipts and issues. The system uses this direct settlement

principle in specific situations:

One receipt and one or several issues have been posted in the period.

Only issues have been posted in the period, and the inventory contains on-hand items from a previous

closing.

In the following scenario, a financially updated receipt and issue have been posted. During inventory close, the

system settles the receipt directly against the issue, and no adjustment to the cost price is required on issue.

The following illustration shows these transactions:

1a. Inventory physical receipt is updated for a quantity of 5 at a cost of USD 10.00 each.

1b. Inventory financial receipt is updated for a quantity of 5 at a cost of USD 10.00 each.

2a. Inventory physical issue is updated for a quantity of 2 at a cost of USD 10.00 each.

2b. Inventory financial issue is updated for a quantity of 2 at a cost of USD 10.00 each.

3. Inventory close is performed by using the direct settlement method to settle the inventory financial

receipt to the inventory financial issue.

Key to the illustration:Key to the illustration:

Inventory transactions are represented by vertical arrows.

Receipts into inventory are represented by vertical arrows above the timeline.

Issues out of inventory are represented by vertical arrows below the timeline.

Above or below each vertical arrow, the value of the inventory transaction is specified in the form

Quantity@Unit price.

If an inventory transaction value is enclosed in parentheses, the inventory transaction is physically posted

into inventory.

If an inventory transaction value isn't enclosed in parentheses, the inventory transaction is financially posted

into inventory.

Each new receipt or issue transaction is designated by a new label.

Each vertical arrow is labeled with a sequential identifier, such as 1a. The identifiers indicate the sequence of

inventory transaction postings in the timeline.

Inventory closings are represented by a red vertical dashed line and the label Inventory Close.

Settlements that are performed by inventory close are represented by dashed red arrows that go diagonally

from a receipt to an issue.



Weighted average date summarized settlement when the Include
physical value option isn't used
Weighted average is based on the principle that all receipts in a closing period are summarized into a new

inventory transfer transaction. This transaction is known as weighted average inventory closing. All the receipts

for the day are settled against the issue of the newly created inventory transfer transaction. All issues for the day

are settled against the receipt of the new inventory transfer transaction. If the on-hand inventory is positive after

the inventory close, the on-hand inventory and the value of the inventory are summarized on the new inventory

transfer transaction receipt. If the on-hand inventory is negative after the inventory close, the on-hand inventory

and the value of the inventory are the sum of individual issues that haven't been fully settled.

In the following scenario, several financially updated receipts and issues have been posted during the period.

During inventory close, the system evaluates every day to determine how each day should be treated by closing.

The following illustration shows these transactions:

Day 1:Day 1:

1a. Inventory physical receipt is updated for a quantity of 3 at USD 15.00 each.

1b. Inventory financial receipt is updated for a quantity of 3 at USD 15.00 each.

2a. Inventory physical issue for a quantity of 1 at a running average cost of USD 15.00.

2b. Inventory financial issue for a quantity of 1 at a running average cost of USD 15.00.

The system will use the direct settlement approach for day 1.

Day 2:Day 2:

3a. Inventory physical issue for a quantity of 1 at a running average cost of USD 15.00

3b. Inventory financial issue for a quantity of 1 at a running average cost of USD 15.00

The system will use the direct settlement approach for day 2.

Day 3:Day 3:

4a. Inventory physical issue for a quantity of 1 at a running average cost of USD 15.00

4b. Inventory financial issue for a quantity of 1 at a running average cost of USD 15.00

5a. Inventory physical receipt for a quantity of 1 at USD 17.00 each

5b. Inventory financial receipt for a quantity of 1 at USD 17.00 each

Inventory close is performed. The direct settlement must be used, because there are multiple receipts that cross

multiple days.

7a. A weighted average inventory close transaction financial issue is created at for a quantity of 2 at USD

32.00 to summarize the settlements of all inventory financial receipts to date that haven't been closed.

7b. A weighted average inventory close transaction financial receipt is created as the offset to 7a.

The system generates and posts the summarized inventory transfer transaction. Additionally, the system settles

all the receipts for the day and on-hand inventory for previous days against the summarized inventory transfer

issue transaction. All the issues for the day are settled against the summarized inventory transfer receipt

transaction. The weighted average cost price is calculated as USD 16.00. The issue will have an adjustment of

USD 1.00 to adjust it to the weighted average cost. The new running average cost price is USD 16.00.

The following illustration shows this series of transactions, and the effects of using the weighted average

inventory model and the summarized settlement principle, but without using the Include physical valueInclude physical value

option.



Weighted average date direct settlement when the Include physical
value option is used

Weighted average date summarized settlement when the Include
physical value option is used

Key to the illustrationKey to the illustration

Inventory transactions are represented by vertical arrows.

Receipts into inventory are represented by vertical arrows above the timeline.

Issues out of inventory are represented by vertical arrows below the timeline.

Above or below each vertical arrow, the value of the inventory transaction is specified in the form

Quantity@Unit price.

If an inventory transaction value is enclosed in parentheses, the inventory transaction is physically posted

into inventory.

If an inventory transaction value isn't enclosed in parentheses, the inventory transaction is financially posted

into inventory.

Each new receipt or issue transaction is designated by a new label.

Each vertical arrow is labeled with a sequential identifier, such as 1a. The identifiers indicate the sequence of

inventory transaction postings in the timeline.

Inventory closings are represented by a red vertical dashed line and the label Inventory Close.

Settlements that are performed by inventory close are represented by dashed red arrows that go diagonally

from a receipt to an issue.

Solid red diagonal arrows show the receipt transactions being settled to the issue transaction that is created

by the system.

The solid green diagonal arrow represents the offsetting system-generated receipt transaction that the

originally posted issue transaction is settled to.

The current version uses the same direct settlement principle for weighted average date that is used in earlier

versions. The system settles directly between receipts and issues. The system uses this direct settlement

principle in specific situations:

One receipt and one or several issues have been posted in the period.

Only issues have been posted in the period, and the inventory contains on-hand inventory from a previous

closing.

If you select the Include physical valueInclude physical value check box for an item on the Item model groupItem model group page, the system

uses physically updated receipts when it calculates the estimated cost price, or running average. Issues are

posted based on this estimated cost price during the period. During the inventory close, only financially updated

receipts will be considered in the weighted average calculation.

If you select the Include physical valueInclude physical value check box for an item on the Item model groupItem model group page, the system

uses physically updated receipts when it calculates the estimated cost price, or running average. Issues are



Weighted average date when marking is used

posted based on this estimated cost price during the period. During the inventory close, only financially updated

receipts will be considered in the weighted average calculation. Weighted average settlement is based on the

principle that receipts in a closing period are summarized into a new inventory transfer transaction that is

known as weighted average inventory closing. All the receipts for the day are settled against the issue of the

newly created inventory transfer transaction. All issues for the day are settled against the receipt of the new

inventory transfer transaction. If the on-hand inventory is positive after the inventory close, that on-hand

inventory and the value of the inventory are summarized on the new inventory transfer transaction (receipt). If

the on-hand inventory is negative after the inventory close, the on-hand inventory and the value of the

inventory are the sum of individual issues that haven't been fully settled.

Marking is a process that lets you link an issue transaction to a receipt transaction. Marking can occur either

before or after a transaction is posted. You can use marking when you want to be sure of the exact cost of the

inventory when the transaction is posted or when the inventory close is performed.

For example, your Customer Service department accepted a rush order from an important customer. Because

this is a rush order, you will have to pay more for this item to meet your customer’s request. You must make

certain that the cost of this inventory item is reflected in the margin, or cost of goods sold (COGS), for this sales

order invoice. When the purchase order is posted, the inventory is received at a cost of USD 120.00. The sales

order document is marked to the purchase order before the packing slip or invoice is posted. The COGS will

then be USD 120.00 instead of the current running average cost for the item. If the sales order packing slip or

invoice is posted before the marking occurs, the COGS will be posted at the running average cost price. Before

inventory close is performed, these two transactions can still be marked to each other. When a receipt

transaction is marked to an issue transaction, the valuation method that is defined in the item’s item model

group will be disregarded. Instead, the system settles these transactions to each other.

You can mark an issue transaction to a receipt before the transaction is posted. You can do this from a sales

order line on the Sales order detailsSales order details  page. You can view the open receipt transactions on the MarkingMarking page.

You can mark an issue transaction to a receipt after the transaction is posted. You can match or mark an issue

transaction for an open receipt transaction for an inventoried item from a posted inventory adjustment journal.

The following illustration shows these transactions:

1a. Inventory physical receipt for a quantity of 1 at a cost price of USD 10.00 each.

1b. Inventory financial receipt for a quantity of 1 at a cost price of USD 10.00 each.

2a. Inventory physical receipt for a quantity of 1 at a cost price of USD 20.00 each.

2b. Inventory financial receipt for a quantity of 1 at a cost price of USD 20.00 each.

3a. Inventory physical receipt for a quantity of 1 at a cost price of USD 25.00 each.

4a. Inventory physical receipt for a quantity of 1 at a cost price of USD 30.00 each.

4b. Inventory financial receipt for a quantity of 1 at a cost price of USD 30.00 each.

5a. Inventory physical issue for a quantity of 1 at a cost price of USD 21.25 (running average of financial and

physical updated transactions).

5b. Inventory financial issue for a quantity of 1 is marked to the inventory receipt 2b before the transaction is

posted. This transaction is posted at a cost price of USD 20.00.

6a. Inventory physical issue for a quantity of 1 at a cost price of USD 21.25.

7. Inventory close is performed. Because the financially updated transaction is marked to an existing

receipt, these transactions are settled to each other, and no adjustment is made.

The new running average cost price reflects the average of the financially and physically updated transactions at

USD 27.50. The following illustration shows this series of transactions, and the effects of using the weighted

average date inventory model and marking.



NOTENOTE

Key to the illustration:Key to the illustration:

Inventory transactions are represented by vertical arrows.

Receipts into inventory are represented by vertical arrows above the timeline.

Issues out of inventory are represented by vertical arrows below the timeline.

Above or below each vertical arrow, the value of the inventory transaction is specified in the form

Quantity@Unit price.

If an inventory transaction value is enclosed in parentheses, the inventory transaction is physically posted

into inventory.

If an inventory transaction value isn't enclosed in parentheses, the inventory transaction is financially posted

into inventory.

Each new receipt or issue transaction is designated by a new label.

Each vertical arrow is labeled with a sequential identifier, such as 1a. The identifiers indicate the sequence of

inventory transaction postings in the timeline.

Inventory closings are represented by a red vertical dashed line and the label Inventory Close.

Settlements that are performed by inventory close are represented by dashed red arrows that go diagonally

from a receipt to an issue.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Weighted average direct settlement without Include physical value

Weighted average is an inventory model based on the weighted average principle, where issues from inventory

are valued at the average value of the items that are received into inventory during the inventory closing period,

plus any on-hand inventory from the previous period.

When you run an inventory closing, all receipts are settled against a virtual issue, which holds the total received

quantity and value. This virtual issue has a corresponding virtual receipt from which the issues are settled. In

this manner, all issues get the same average cost. The virtual issue and receipt can be seen as a virtual transfer,

which is named the weighted average inventory closing transfer.

If there is only one receipt, all issues can be settled from it and the virtual transfer will not be created.

When using weighted average, you can mark inventory transactions so that a specific item receipt is settled

against a specific issue, instead of using the weighted average rule.

We recommend a monthly inventory closing when you use the weighted average inventory model.

The weighted average inventory costing method is calculated by the following formula:

Weighted average = (Q1*P1 + Q2*P2 + Qn*Pn) / (Q1 + Q2 + Qn)

Inventory transactions leaving the inventory issues. This includes sales orders, inventory journals, and

production orders, occur at an estimated cost price on the posting date. This estimated cost price is also referred

to as running average. At the time of inventory close, the system will analyze the inventory transactions for

previous and current periods and determine which of the following closing principles should be used.

Direct settlement

Summarized settlement

Settlements are inventory close postings that adjust the issues to the correct weighted average as of the closing

date. The following examples illustrate the effect of using weighted average with five different configurations:

Weighted average direct settlement without the Include physical value option

Weighted average summarized settlement without the Include physical value option

Weighted average direct settlement with the Include physical value option

Weighted average summarized settlement with the Include physical value option

Weighted average with marking

The direct settlement principle is the same used for weighted average in earlier versions. The system will settle

directly between receipts and issues. The system uses this direct settlement principle in certain specific

situations:

One receipt and one or several issues has been posted in the period

Only issues have been posted in the period and the inventory contains on-hand items from a previous

closing

In the scenario in the following sections, a financially updated receipt and issue have been posted. During

inventory close, the system will settle the receipt directly against the issue, and no adjustment to the cost price is

needed on issue. The following transactions are illustrated in the graphic.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/weighted-average-physical-value-marking.md


Weighted average summarized settlement without the Include
physical value option

1a. Inventory physical receipt updated for a quantity of 5 at USD 10.00 each

1b. Inventory financial receipt updated for a quantity of 5 at USD 10.00 each

2a. Inventory physical issue updated for a quantity of 2 at USD 10.00 each

2b. Inventory financial issue updated for a quantity of 2 at USD 10.00 each

3. Inventory close is performed using the direct settlement method to settle the inventory financial

receipt to the inventory financial issue.

The following diagram illustrates this series of transactions with the effects of choosing the Weighted average

inventory model and the direct settlement principle without the Include physical value option.

Key to diagramKey to diagram

Inventory transactions are represented by vertical arrows.

Receipts into inventory are represented by vertical arrows above the timeline.

Issues out of inventory are represented by vertical arrows below the timeline.

Above (or below) each vertical arrow, the value of the inventory transaction is specified in the format

Quantity@Unitprice.

An inventory transaction value enclosed in brackets indicates that the inventory transaction is physically

posted into inventory.

An inventory transaction value without brackets indicates that the inventory transaction is financially posted

into inventory.

Each new receipt or issue transaction is designated with a new label.

Each vertical arrow is labeled with a sequential identifier, such as 1a. The identifiers indicate the sequence of

inventory transaction postings in the timeline.

Inventory closings are represented by a red vertical dashed line and the label Inventory Close.

Settlements that are performed by inventory close are represented by dotted red arrows going diagonally

from a receipt to an issue.

Weighted average uses the settlement principle that all receipts within in a closing period are summarized into a

transaction called Weighted average inventory closing. All the receipts for the period will be settled against the

issue of the newly created inventory transfer transaction. All issues for the period will be settled against the

receipt of the new inventory transfer transaction. If the on-hand inventory is positive after the inventory close,

that on-hand inventory and value of the inventory are summarized on the new inventory transfer transaction

(receipt). If the inventory on-hand is negative after the inventory close, the on-hand inventory and value of the

inventory is the sum of individual issues that have not been fully settled. In the scenario below, several

financially updated receipts and one issue have been posted.

During inventory close, the system will generate and post the summarized inventory transfer transaction and

settle the receipts for the period against the summarized inventory transfer issue transaction. All the issues

posted for the period will be settled against the summarized inventory transfer receipt transaction. The



weighted average is calculated to be USD 15.00. The issue was originally posted with an estimated cost price of

USD 14.67. Therefore, an adjustment of negative USD 0.33 will be created and posted on the issue. As of the

inventory closing date, the on-hand inventory is 3 pieces with a value of USD 45.00.

The following transactions are illustrated in the graphic below:

1a. Inventory physical receipt updated for a quantity of 2 at a cost of USD 11.00 each.

1b. Inventory financial receipt updated for a quantity of 2 at a cost of USD 14.00 each.

2a. Inventory physical receipt updated for a quantity of 1 at a cost of USD 12.00 each.

2b. Inventory financial receipt updated for a quantity of 1 at a cost of USD 16.00 each.

3a. Inventory physical issue updated for a quantity of 1 at a cost of USD 14.67 each (running average).

3b. Inventory financial issue updated for a quantity of 1 at a cost of USD 14.67 each (running average).

4a. Inventory physical receipt updated for a quantity of 1 at a cost of USD 14.00 each.

4b. Inventory financial receipt updated for a quantity of 1 at a cost of USD 16.00 each.

6a. “Weighted average inventory close transaction” financial issue is created to sum the settlements of all the

inventory financial receipts.

6b. “Weighted average inventory close transaction” financial receipt is created as the offset to 5a.

5. Inventory close is performed.

The following diagram illustrates this series of transactions with the effects of choosing the Weighted average

inventory model and the summarized settlement principle without the Include physical value option.

Key to diagramKey to diagram

Inventory transactions are represented by vertical arrows.

Receipts into inventory are represented by vertical arrows above the timeline.

Issues out of inventory are represented by vertical arrows below the timeline.

Above (or below) each vertical arrow, the value of the inventory transaction is specified in the format

Quantity@Unitprice.

An inventory transaction value enclosed in brackets indicates that the inventory transaction is physically

posted into inventory.

An inventory transaction value without brackets indicates that the inventory transaction is financially posted

into inventory.

Each new receipt or issue transaction is designated with a new label.

Each vertical arrow is labeled with a sequential identifier, such as 1a. The identifiers indicate the sequence of

inventory transaction postings in the timeline.

Inventory closings are represented by a red vertical dashed line and the label Inventory Close.

Settlements that are performed by inventory close are represented by dotted red arrows going diagonally

from a receipt to an issue.

Red arrows illustrate the receipt transactions being settled to the issue transaction created by the system.

The green arrow represents the offsetting system-generated receipt transaction to which the originally

posted issue transaction is settled



Weighted average direct settlement with the Include physical value
option
The parameter Include physical value works differently with the weighted average inventory model than in

earlier versions of the product. Select the Include physical value box for an item in the Item model group form.

Then the system will use physically updated receipts when calculating the estimated cost price, or running

average. Issues will be posted based on this estimated cost price during the period. During the inventory close,

financially updated receipts only will be considered in the weighted average calculation. We recommend a

monthly inventory close when you use the weighted average inventory model. In this weighted average direct

settlement example, the item model group is marked to include physical value.

The following transactions are illustrated in the graphic below:

1a. Inventory physical receipt updated for a quantity of 1 at a cost of USD 11.00 each.

1b. Inventory financial receipt updated for a quantity of 1 at a cost of USD 10.00 each.

2a. Inventory physical receipt updated for a quantity of 1 at a cost of USD 15.00 each.

3a. Inventory physical issue updated for a quantity of 1 at a cost of USD 12.50 each (running average cost,

since the physical receipt value is taken into consideration).

3b. Inventory financial issue updated for a quantity of 1 at a cost of USD 12.50 each (running average cost,

since the physical receipt value is taken into consideration).

4. Inventory close is performed. During inventory close, the system will disregard all inventory

transactions that have been only physically updated. Instead, the direct settlement principle will be

used because only one financial receipt exists. An adjustment of USD 2.50 will be posted to the

inventory transaction that has been financially issued as of the inventory closing date. After inventory

close, the on hand inventory will be a quantity of 1 with a running average cost price of USD 15.00.

The following diagram illustrates this series of transactions with the effects of choosing the Weighted average

inventory model and the direct settlement principle with the Include physical value option.

Key to diagramKey to diagram

Inventory transactions are represented by vertical arrows.

Receipts into inventory are represented by vertical arrows above the timeline.

Issues out of inventory are represented by vertical arrows below the timeline.

Above (or below) each vertical arrow, the value of the inventory transaction is specified in the format

Quantity@Unitprice.

An inventory transaction value enclosed in brackets indicates that the inventory transaction is physically

posted into inventory.

An inventory transaction value without brackets indicates that the inventory transaction is financially posted

into inventory.

Each new receipt or issue transaction is designated with a new label.

Each vertical arrow is labeled with a sequential identifier, such as 1a. The identifiers indicate the sequence of

inventory transaction postings in the timeline.

Inventory closings are represented by a red vertical dashed line and the label Inventory Close.



Weighted average summarized settlement with the Include physical
value option

Settlements that are performed by inventory close are represented by dotted red arrows going diagonally

from a receipt to an issue.

The Include physical value parameter works differently with weighted average than in earlier versions. Select the

Include physical value box for an item in the Item model group page. Then the system will use physically

updated receipts in the calculation of estimated cost price, or running average. Issues will be posted based on

this estimated cost price during the period. During the inventory close financially updated receipts only will be

considered in the weighted average calculation. We recommend a monthly inventory close when you use the

weighted average inventory model. In this weighted average summarized settlement example, the inventory

model is marked to include physical value.

The following transactions are illustrated in the graphic below:

1a. Inventory physical receipt updated for a quantity of 2 at a cost of USD 11.00 each.

1b. Inventory financial receipt updated for a quantity of 2 at a cost of USD 14.00 each.

3a. Inventory physical receipt updated for a quantity of 1 at a cost of USD 12.00 each.

3b. Inventory financial receipt updated for a quantity of 1 at a cost of USD 16.00 each.

4a. Inventory physical issue updated for a quantity of 1 at a cost of USD 13.50 each (running average cost,

since the physical receipt value is taken into consideration).

4b. Inventory financial issue updated for a quantity of 1 at a cost of USD 13.50 each (running average cost,

since the physical receipt value is taken into consideration).

5a. Inventory physical receipt updated for a quantity of 1 at a cost of USD 14.00 each.

5b. Inventory financial receipt updated for a quantity of 1 at a cost of USD 16.00 each.

7a. “Weighted average inventory close transaction” financial issue is created to sum the settlements of all the

inventory financial receipts.

7b. “Weighted average inventory close transaction” financial receipt is created as the offset to 5a.

2. Inventory physical receipt updated for a quantity of 1 at a cost of USD 10.00 each.

6. Inventory close is performed. During inventory close, the system will disregard all inventory

transactions that are updated only physically. The summarized settlement principle will be used

because only one financial receipt exists. An adjustment of USD 1.50 will be posted to the inventory

transaction that has been financially issued as of the inventory closing date. After inventory close, the

on- hand inventory will be a quantity of 3 with a running average cost price of USD 15.00.

The following diagram illustrates this series of transactions with the effects of choosing the weighted average

inventory model and the summarized settlement principle without the Include physical value option.

Key to diagramKey to diagram

Inventory transactions are represented by vertical arrows.

Receipts into inventory are represented by vertical arrows above the timeline.



Weighted average with marking

Issues out of inventory are represented by vertical arrows below the timeline.

Above (or below) each vertical arrow, the value of the inventory transaction is specified in the format

Quantity@Unitprice.

An inventory transaction value enclosed in brackets indicates that the inventory transaction is physically

posted into inventory.

An inventory transaction value without brackets indicates that the inventory transaction is financially posted

into inventory.

Each new receipt or issue transaction is designated with a new label.

Each vertical arrow is labeled with a sequential identifier, such as 1a. The identifiers indicate the sequence of

inventory transaction postings in the timeline.

Inventory closings are represented by a red vertical dashed line and the label Inventory Close.

Settlements that are performed by inventory close are represented by dotted red arrows going diagonally

from a receipt to an issue.

Red arrows illustrate the receipt transactions being settled to the issue transaction created by the system.

The green arrow represents the offsetting system-generated receipt transaction to which the originally

posted issue transaction is settled

Marking is a process that lets you link, or mark, an issue transaction to a receipt transaction. Marking can occur

either before or after a transaction is posted. You can use marking when you want to make sure of the exact cost

of the inventory when the transaction is posted or when the inventory close is performed.

For example, your Customer Service department accepted a rush order from an important customer. Because

this is a rush order, you will have to pay more for this item to service your customer’s request. You must be

certain the cost of this inventory item is reflected in the margin, or cost of goods sold (COGS), for this sales

order invoice.

When the purchase order is posted, the inventory is received at a cost of USD 120.00. For example, this sales

order document is marked to the purchase order before the packing slip or invoice is posted. Then COGS will be

USD 120.00 instead of the current running average cost for the item. If the sales order packing slip or invoice is

posted before the marking occurs, the COGS will be posted at the running average cost price.

Before inventory close is performed, these two transactions can still be marked to each other.

A receipt transaction is marked to an issue transaction. Then, the valuation method selected for the item’s item

model group will be disregarded and the system will settle these transactions to each other.

You can mark an issue transaction to a receipt before the transaction is posted. You can do this from a sales

order line in the Sales order details page. The open receipt transactions are viewed in the Marking page.

You can mark an issue transaction to a receipt after the transaction has been posted. You can match or mark an

issue transaction for an open receipt transaction for an inventoried item from a posted inventory adjustment

journal.

The following transactions are illustrated in the graphic below:

1a. Inventory physical receipt for a quantity of 1 at a cost of USD 10.00 each.

1b. Inventory financial receipt for a quantity of 1 at a cost of USD 10.00 each.

2a. Inventory physical receipt for a quantity of 1 at a cost of USD 20.00 each.

2b. Inventory financial receipt for a quantity of 1 at a cost of USD 20.00 each.

3a. Inventory physical receipt for a quantity of 1 at a cost of USD 25.00 each.

4a. Inventory physical receipt for a quantity of 1 at a cost of USD 30.00 each.

4b. Inventory financial receipt for a quantity of 1 at a cost of USD 30.00 each.



NOTENOTE

5a. Inventory physical issue for a quantity of 1 at a cost price USD 21.25 (running average of financial and

physical updated transactions).

5b. Inventory financial issue for a quantity of 1 is marked to the inventory receipt 2b before the transaction is

posted. This transaction is posted with a cost price of USD 20.00.

6a. Inventory physical issue for a quantity of 1 at a cost price of USD 21.25 each.

7 Inventory close is performed. Since the financially updated transaction is marked to an existing receipt

these transactions are settled to each other and no adjustment is made.

The new running average cost price reflects the average of the financially and physically updated transactions at

USD 27.50.

The following diagram illustrates this series of transactions with the effects of choosing the Weighted average

inventory model with marking.

Key to diagramKey to diagram

Inventory transactions are represented by vertical arrows.

Receipts into inventory are represented by vertical arrows above the timeline.

Issues out of inventory are represented by vertical arrows below the timeline.

Above (or below) each vertical arrow, the value of the inventory transaction is specified in the format

Quantity@"Unitprice".

An inventory transaction value enclosed in brackets indicates that the inventory transaction is physically

posted into inventory.

An inventory transaction value without brackets indicates that the inventory transaction is financially posted

into inventory.

Each new receipt or issue transaction is designated with a new label.

Each vertical arrow is labeled with a sequential identifier, such as 1a. The identifiers indicate the sequence of

inventory transaction postings in the timeline.

Inventory closings are represented by a red vertical dashed line and the label Inventory Close.

Settlements that are performed by inventory close are represented by dotted red arrows going diagonally

from a receipt to an issue.
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The survey will take about seven minutes. No personal data is collected (privacy statement).
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Inventory recalculation and the general ledger

Effects of the inventory close process on the general ledger

As part of the process to settle issue transactions with receipt transactions, you can also choose to have the

general ledger updated to reflect the adjustments that have been made.

The inventory close process settles issue transactions to receipt transactions, based on the inventory valuation

method that is selected in the item’s item model group. As part of the settlement process, you can specify that

the general ledger should be updated, so that it reflects the adjustments that have been made. However, until

inventory close or recalculation has been run, issue transactions are posted at the calculated running average

cost price.

After inventory close, you can no longer post in periods that are before the inventory closing date that you set,

unless you reverse a completed inventory close process. For example, if inventory close is run for the period

that ends on January 31, you can't post transactions that have a date that is earlier than January 31.

Items in inventory are assigned to one of two inventory types: item or service. Inventory close performs the

same functions for both types. However, for service items, inventory close still settles issues to receipts.

How often the inventory close process is run varies by company. However, transaction volume should help

determine how often you decide to run inventory close. In general, most companies run inventory close as part

of their month-end close and reconciliation procedures.

If adjustments to inventory and the general ledger are required during a month or other inventory period, you

can run inventory recalculation instead of inventory close. Inventory recalculation makes adjustments but

doesn't make settlements to inventory transactions.

During inventory recalculation, on-hand inventory is adjusted, inventory transactions are adjusted, and

inventory recalculations and inventory closes are run. These tasks affect any ledger account that is linked to the

original inventory transaction.

ExampleExample

When you create a purchase order from a sales order, the general ledger accounts that are used for the original

sales order are updated. Even if the ledger accounts for the item group that is assigned to the item were

changed after the sales order was posted, and an inventory recalculation created an adjustment amount, the

adjustment amount is posted to the original ledger accounts. The adjusted amount isn’t posted to the new

ledger accounts that are assigned to the item.

After the update is completed, you can review the ledger voucher that is posted because of one of these tasks.

1. On the Closing and adjustmentClosing and adjustment page, on the Over viewOver view  tab, select the update to review.

2. Click DetailsDetails , and then select VoucherVoucher .

Several of the tasks that you can perform on the Closing and adjustmentClosing and adjustment page cause an update to general

ledger. For example, the general ledger is updated when you make inventory on-hand adjustments, make

inventory transaction adjustments, run inventory recalculation, and run inventory close.

The ledger accounts that are updated because of these tasks are linked to the original inventory transaction. For

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/inventory-close.md


NOTENOTE

The inventory close log

Reversing a completed inventory close

example, if a sales order is settled to a purchase order, the general ledger accounts that were used for the

original sales order are adjusted. This behavior occurs even if the ledger accounts for the item group that is

assigned to the item have changed since the sales order was posted. After inventory close creates a settlement

amount, the settlement amount is still posted to the original ledger accounts, not to the new ledger accounts

that are assigned to the item. The general ledger might also be updated if you reverse an inventory close.

Inventory close is a required step in the month-end closing procedure for all inventory models except moving average.

You will be warned if you try to close a financial period without first performing the inventory close as of the period

end date.

Before you run the closing procedure, you can view a list of items that can't be settled during the update.

We recommend that you run inventory close during off-peak hours, to distribute computing resources more evenly.

After the inventory close process has been completed, a message in the message center might inform you that a

unit cost price might be incorrect because a transaction could not be fully settled.

Before this message is shown, the system reports the item number and the affected transaction. The message

informs you that the cost amount that is used for this transaction wasn't updated because of the inventory close.

This message appears when a transaction of the issue type can't be settled.

During the inventory close process, the system checks each financial dimension to see whether there are more

issues than receipts up to the specified closing date. This type of imbalance can occur when an inventory

transaction from a purchase order isn't fully posted financially, either because the vendor invoice hasn't been

received, or because bill of materials (BOM) components that are included in a production on a higher level

aren't financially posted. (The sub-production isn't cost-calculated.) In this case, the subsequent close won't

adjust all issues to the correct cost price, because not enough receipt information is available.

For each run of the closing procedure, the system indicates whether a log that contains the warnings is stored

and can be viewed.

If you receive many warnings in the message, we recommend that you perform the following actions:

Update receipts financially.

Advance the closing date.

Reevaluate the business procedures.

In some circumstances, you might not be able to do anything about the warnings. For example, if marking is

used, and the marked purchase order has a financial date that is after the closing date, the closing date can't be

changed.

Occasionally, you might have to reverse a completed inventory close to return settlements to the state that they

had before adjustments were made. When you reverse a completed inventory close, inventory is reopened to

enable posting in the period that the inventory close covers. Related changes might also be made in the general

ledger. After you've finished making adjustments, you can run inventory close again for the period that you're

working with.



NOTENOTE

NOTENOTE

Only the last inventory period that was closed can be reopened. To reverse an earlier inventory close, you must reverse

each subsequent inventory close one at a time, starting with the most recent close.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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NOTENOTE

Use the Adjustment of on-hand inventory page to adjust the cost value of the on-hand inventory quantities after

an inventory close process is run.

You can use the Adjustment of on-hand inventor yAdjustment of on-hand inventor y  page to adjust the cost value of on-hand inventory

quantities after an inventory close process is run. Note:Note: To open the Adjustment of on-hand inventor yAdjustment of on-hand inventor y

page, on the Closing and adjustmentClosing and adjustment page, select the record of a completed inventory close process, and

then click AdjustmentAdjustment > On-handOn-hand. Example:Example: You have the following transactions in February:

February 1: An inventory financial receipt for a quantity of 2 at a cost of USD 10.00

February 5: An inventory financial receipt for a quantity of 1 at a cost of USD 13.00

February 19: An inventory financial issue for a quantity of 1 at a running average cost of USD 11.00

This item was set up with the first in, first out (FIFO) inventory model, and inventory close was performed as of

February 28. The financial issue transaction of USD 11.00 will be settled against the financial receipt that is

dated February 1, and an adjustment of USD 1.00 will be made. The following inventory receipts will then

contain open inventory quantities:

February 1: A quantity of 1 at a cost of USD 10.00

February 5: A quantity of 1 at a cost of USD 13.00

To set the cost of these two items to USD 15.00, use the on-hand adjustment option to adjust the open on-hand

quantities as of the last inventory close period. Note:Note: The posting date of the on-hand adjustment transaction

will be the date of the last inventory close. This date can't be modified.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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NOTENOTE

Turn on the Inventory value storage feature

Generate an Inventory value storage report

This topic explains how to run an Inventor y value storageInventor y value storage report and make the output available digitally,

either as an interactive page in Microsoft Dynamics 365 Supply Chain Management or as an exported document

in any of several formats.

When you view the report in your browser, columns and aggregate balances are dynamically adjusted,

depending on the layout that you've configured. You can sort the results, filter them, drill down into the data,

and more.

Report results are stored in the Inventor y valueInventor y value data entity. Therefore, you can filter and export the results to a

format such as comma-separated values (CSV) or Microsoft Excel format.

The Inventor y value storageInventor y value storage report is helpful when the output contains many lines. For example, you have

50,000 items, and 300 stores have been created as warehouses. In this case, if you request inventory ending

balances by item, site, and warehouse, the output will contain many lines.

The report won't include subtotals that are defined in the report layout. It also won't include general ledger balances, even

when they are defined in the report layout. Reconciliation to the general ledger must be done by using trial balances.

Before you can generate an Inventor y value storageInventor y value storage report, you must turn on the feature in your system.

Administrators can use the feature management settings to check the status of the feature and turn it on if it's

required. In the Feature managementFeature management workspace, the feature is listed in the following way:

ModuleModule – Cost management

Feature nameFeature name – Inventory value storage

Follow these steps to generate and store an Inventor y value storageInventor y value storage report.

1. Go to Cost management > Inquir ies and repor ts > Inventor y value repor t storageCost management > Inquir ies and repor ts > Inventor y value repor t storage.

2. Select NewNew .

3. In the Inventor y valueInventor y value dialog box that appears, set the following values to define which records are

included in your report:

On the ParametersParameters  FastTab, enter a unique name for the report, and use the fields in the DateDate

inter valinter val  section to define which records are included in the report. To define the date interval, you

can either select a preset range (relative to the report generation date) in the Date inter val codeDate inter val code

field, or select specific dates in the From dateFrom date and To dateTo date fields.

On the Records to includeRecords to include FastTab, set up filters and constraints to define which data is included in

the report.

On the Run in the backgroundRun in the background FastTab, specify how, when, and how often the report is generated.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/inventory-value-report-storage.md


Explore an Inventory value storage report

Export an Inventory value storage report

NOTENOTE
This report is always run as part of a batch job.

4. Select OKOK to apply your settings and close the dialog box.

After the batch job is completed, the report will be listed on the Inventor y value repor t storageInventor y value repor t storage page. You

might have to refresh the page to see the report.

After you've generated a report, you can view and explore it at any time by following these steps.

1. Go to Cost management > Inquir ies and repor ts > Inventor y value repor t storageCost management > Inquir ies and repor ts > Inventor y value repor t storage.

2. Select a report in the list.

3. Select View detailsView details  to show the report content.

4. Explore the report by following any of these steps:

As for most standard pages in Supply Chain Management, you can select almost any column heading

to sort or filter the grid by the values in that column.

Use the FilterFilter  field to filter the report by any value in any of several available columns.

Use the view menu (above the FilterFilter  field) to save and load your favorite combinations of sort and

filter options.

Every report that you generate is stored in the Inventor y valueInventor y value data entity. You can use the standard data

management features of Supply Chain Management to export data from this entity to any supported data

format, such as CSV or Excel format.

The following example shows how to export an Inventor y value repor tInventor y value repor t report.

1. Go to System administration > Workspaces > Data managementSystem administration > Workspaces > Data management.

2. In the Impor t / Expor tImpor t / Expor t section, select the Expor tExpor t tile.

3. On the Expor tExpor t page that appears, you will set up the export job. First enter a group name for the job.

4. In the Selected entitiesSelected entities  section, select Add entityAdd entity .

5. In the dialog box that appears, set the following fields:

Entity nameEntity name – Select Inventor y valueInventor y value.

Target data formatTarget data format – Select the format to export data to.

6. Select AddAdd to add the new row, and then select CloseClose to close the dialog box.

7. Usually, you will export one report at a time. To export a single report, set up a filter for the row that you

just added to the Inquir yInquir y  dialog box. In this way, you can define which report from the Inventor y valueInventor y value

entity is included in your export. Follow these steps to set the following filter options to export a single

report:

a. On the RangeRange tab, select AddAdd to add a row.

b. Set the TableTable field to Inventor y valueInventor y value.

c. Set the Derived tableDerived table field to Inventor y valueInventor y value.
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d. Set the FieldField field to the field that you want to filter by. Usually, you will use the Execution nameExecution name

field and/or the Execution timeExecution time field.

e. Set the Criter iaCriter ia field to the value that you want to look for in the selected field. (If you selected the

Execution nameExecution name field in the previous step, this value will be the name of the report. If you selected

the Execution timeExecution time field, it will be the time when the report was generated.)

f. Add more rows to the RangeRange tab as you require, until you've uniquely identified the report that you're

looking for.

8. Select OKOK to save your settings and close the dialog box.

9. Select SaveSave to save your export setup.

10. On the Expor t optionsExpor t options  tab, select Expor t nowExpor t now  to generate the export file.

11. On the Execution summar yExecution summar y  page that appears, you can view the status of your export job and a list of

the entities that were exported. In the Entity processing statusEntity processing status  section, select the Inventor y valueInventor y value

entity in the list, and then select Download fileDownload file to download the data that was exported from that entity.

For more information about how to use data management to export data, see Data import and export jobs

overview.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Enable the Inventory value storage report feature

Run an Inventory aging report storage

NOTENOTE

In Microsoft Dynamics 365 Supply Chain Management, you can run an Inventor y aging repor t storageInventor y aging repor t storage

report and make the output available as a form and a chart. In the form, columns and aggregate balances are

dynamically adjusted, depending on the layout that is configured. The chart provides a visual overview that

supports filtering and lets you drill down into details. Additionally, a data entity that is named Inventor y agingInventor y aging

repor trepor t lets you export the results of an Inventor y aging repor t storageInventor y aging repor t storage report run to a format such as a

Microsoft Excel file or a PDF file.

This method of running an Inventor y aging repor t storageInventor y aging repor t storage report is helpful in cases where the output

contains many lines. For example, the output will contain many lines if you have 50,000 items and 300 stores

that are created as warehouses, and you request inventory aging by item, site, and warehouse.

Before you can use this feature, you must enable it on your system. Administrators can use the feature

management settings to check the feature status and enable it if needed. Here, the feature is listed as:

ModuleModule - Cost management

Feature nameFeature name - Inventory aging report storage

NOTENOTE

1. Go to Cost management > Inquir ies and repor ts > Inventor y aging repor t storageCost management > Inquir ies and repor ts > Inventor y aging repor t storage.

2. Select NewNew .

3. In the Process Identifier  – NameProcess Identifier  – Name field, enter a unique name for the report.

4. Select the Identification – IDIdentification – ID report, and filter it as you require.

Report execution is always done in a batch job.

5. After the batch job is completed, the output is shown on the Inventor y aging repor t storageInventor y aging repor t storage page.

6. To view the output as a form that has a traditional grid layout, select View detailsView details . To view the output as

an aggregated chart, select View char tView char t.

The form won't include subtotals that are defined in the report layout.

The Inventor y aging repor tInventor y aging repor t data entity lets you export the output of an Inventor y aging repor t storageInventor y aging repor t storage

report by applying a filter for the Process Identifier  – NameProcess Identifier  – Name field to any format that Data management

supports.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/inventory-aging-report-storage.md
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Sample data that is used in these examples

Storage dimension setupStorage dimension setup

N A M EN A M E A C T IVEA C T IVE P H Y SIC A L  IN VEN TO RYP H Y SIC A L  IN VEN TO RY F IN A N C IA L  IN VEN TO RYF IN A N C IA L  IN VEN TO RY

Site Yes Yes Yes

Warehouse Yes Yes No

Inventory modelInventory model

Inventory transactionsInventory transactions

REF EREREF ERE
N C EN C E SIT ESIT E

WA REHWA REH
O USEO USE REC EIP TREC EIP T ISSUEISSUE

P H Y SICP H Y SIC
A L  DAT EA L  DAT E

F IN A N CF IN A N C
IA LIA L
DAT EDAT E

Q UA N T IQ UA N T I
T YT Y

C O STC O ST
A M O UNA M O UN
TT

P H Y SICP H Y SIC
A LA L
C O STC O ST
A M O UNA M O UN
TT

Purchas
e order

1 11 Purchas
ed

March
15

March
15

10 1,000 1,000

Purchas
e order

2 21 Purchas
ed

March
15

March
15

10 2,000 2,000

Purchas
e order

1 11 Received April 15 5 375

Transfer
order

1 11 Sold May 2 May 2 -5 -458.33 -458.33

This topic presents some examples that show how to interpret the results of an Inventor y agingInventor y aging report. This

report categorizes on-hand quantity and inventory values for a selected item or item group into several period

buckets. This topic also shows the internal logic of the report.

The examples in this topic show results that are presented on a standard Inventor y agingInventor y aging report. However, in

general, we recommend that you use the Inventory aging report storage version of this report, especially when

you have many items and warehouses that must be processed. Inventory aging report storage saves each

report that you generate, shows the results as an interactive page and a chart, and lets you export any saved

report.

The examples in this topic are based on the sample inventory transaction data that is described in this section.

The example system contains the following setup of storage dimensions.

For the example system, the inventory model for the released products is FIFO, and the Cost pr iceCost pr ice setting for

the inventory model is Include physical value.

The example system contains the following inventory transactions for a released product that has the item

number 1000.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/inventory-aging-report.md


Transfer
order

1 12 Purchas
ed

May 2 May 2 5 458.33 458.33

Sales
order

1 12 Sold May 3 May 3 -1 -91.67 -91.67

REF EREREF ERE
N C EN C E SIT ESIT E

WA REHWA REH
O USEO USE REC EIP TREC EIP T ISSUEISSUE

P H Y SICP H Y SIC
A L  DAT EA L  DAT E

F IN A N CF IN A N C
IA LIA L
DAT EDAT E

Q UA N T IQ UA N T I
T YT Y

C O STC O ST
A M O UNA M O UN
TT

P H Y SICP H Y SIC
A LA L
C O STC O ST
A M O UNA M O UN
TT

How quantities and amounts in each period bucket are calculated

IT EMIT EM
N UMN UM
B ERB ER SIT ESIT E

O N -O N -
H A NH A N
DD
Q UAQ UA
N T ITN T IT
YY

O N -O N -
H A NH A N
DD
VA L UVA L U
EE

IN VEIN VE
N TON TO
RYRY
VA L UVA L U
EE
Q UAQ UA
N T ITN T IT
YY

IN VEIN VE
N TON TO
RYRY
VA L UVA L U
EE

AVERAVER
A GEA GE
UN ITUN IT
C O STC O ST

5/ 8/ 2020 -5/ 8/ 2020 -
5/ 1/ 20205/ 1/ 2020

4/ 30/ 2020 -4/ 30/ 2020 -
4/ 1/ 20204/ 1/ 2020

3/ 31/ 2020 -3/ 31/ 2020 -
3/ 1/ 20203/ 1/ 2020

P 1: QP 1: Q
UA NUA N
T IT YT IT Y

P 1: AP 1: A
M O UM O U
N TN T

P 2: QP 2: Q
UA NUA N
T IT YT IT Y

P 2: AP 2: A
M O UM O U
N TN T

P 3: QP 3: Q
UA NUA N
T IT YT IT Y

P 3: AP 3: A
M O UM O U
N TN T

1000 1 14 1,28
3.33

14 1,28
3.33

91.6
7

5.00 458.
33

9.00 825.
00

1000 2 10 2,00
0.00

10 2,00
0.00

200.
00

10.0
0

2,00
0.00

100100
00
TotalTotal
ss

24.024.0
00

3,283,28
3.333.33

5.005.00 458.458.
3333

1919 2,822,82
5.005.00

By using the sample data that is described in the previous sections, you can run an Inventor y agingInventor y aging report that

has the following settings:

As of date:As of date: May 9, 2020

Site:S ite: View

Warehouse:Warehouse: No

Item number :Item number : Total

Aging period:Aging period: Set this field to generate monthly buckets.

In this case, the content of the report that is generated will resemble the following example.

Note the following details in this example report:

The Inventor y value quantityInventor y value quantity , Inventor y valueInventor y value, and Average unit costAverage unit cost values that are shown on

the report are values for the financial inventory dimension (S iteSite, in this case).

For example, for site 1, the report shows the following information:

The Inventor y value quantityInventor y value quantity  value is 14 (= 10 + 5 – 5 + 5 – 1).

The Inventor y valueInventor y value value is 1,283.33 (= 1,000 + 375 – 458.33 + 458.33 – 91.67).

The Average unit costAverage unit cost value is 91.67.

The On-hand valueOn-hand value value and the AmountAmount value in each period bucket are calculated by using the

Average unit costAverage unit cost value.

The report determines the on-hand quantity for each period bucket by summarizing the total received
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5/ 8/ 2020 -5/ 8/ 2020 -
5/ 1/ 20205/ 1/ 2020

4/ 30/ 2020 -4/ 30/ 2020 -
4/ 1/ 20204/ 1/ 2020
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3/ 1/ 20203/ 1/ 2020
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100
0

1 11 10 916.
67

14 1,28
3.33

91.6
7

5.00 458.
33

5.00 458.
33

100
0

1 12 4 366.
67

14 1,28
3.33

91.6
7

4.00 366.
67

100
0

2 10 2,00
0.00

10 2,00
0.00

200.
00

10.0
0

2,00
0.00

100100
00
TotaTota
lsls

24.24.
0000

3,23,2
83.83.
3333

4.04.0
00

366366
.67.67

5.05.0
00

458458
.33.33

1515 2,42,4
58.58.
3333

Effects of inventory closing

5/ 31/ 2020 -5/ 31/ 2020 -
5/ 1/ 20205/ 1/ 2020

4/ 30/ 2020 -4/ 30/ 2020 -
4/ 1/ 20204/ 1/ 2020

3/ 31/ 2020 -3/ 31/ 2020 -
3/ 1/ 20203/ 1/ 2020

100100
00
TotaTota
lsls

24.24.
0000

3,23,2
75.75.
0000

4.04.0
00

364364
.29.29

5.05.0
00

455455
.36.36

1515 2,42,4
55.55.
3636

inventory quantity for each period bucket. It then applies the first in, first out (FIFO) principle to deduct

the total issued quantity, regardless of the inventory model that the items use.

If you run the same report again, but this time you set both the S iteSite and WarehouseWarehouse fields to View, the new

report will resemble the following example.

This time, site 1 is split into two rows, one for warehouse 11 and one for warehouse 12. However, the Inventor yInventor y

value quantityvalue quantity , Inventor y valueInventor y value, and Average unit costAverage unit cost values are the same, because WarehouseWarehouse isn't a

financial inventory dimension.

Additionally, notice that the quantity distribution of site 1 is different. In the first report that you ran, the system

ignored the transfer order that occurred in the same site and deducted the quantity of the sales invoice from the

3/31/2020 - 3/1/20203/31/2020 - 3/1/2020  period bucket in site 1. However, in the new report, the system deducts the quantity of

the sales invoice from the 5/8/2020 - 5/1/20205/8/2020 - 5/1/2020  period bucket in warehouse 12.

If you run the inventory closing for May and then run the previous report again, but you set the As of dateAs of date field

to May 31, 2020, you will notice the following results:

The Inventor y valueInventor y value and Average unit costAverage unit cost values are updated.

The On-hand valueOn-hand value value and all the AmountAmount values in every period bucket are updated accordingly.

The new report will resemble the following example.



IT EIT E
MM
N UN U
M B EM B E
RR SIT ESIT E

WA RWA R
EH OEH O
USEUSE

O N -O N -
H A NH A N
DD
Q UAQ UA
N T IN T I
T YT Y

O N -O N -
H A NH A N
DD
VA LVA L
UEUE

IN VEIN VE
N TON TO
RYRY
VA LVA L
UEUE
Q UAQ UA
N T IN T I
T YT Y

IN VEIN VE
N TON TO
RYRY
VA LVA L
UEUE

AVEAVE
RA GRA G
EE
UN IUN I
TT
C O SC O S
TT

P 1: QP 1: Q
UA NUA N
T IT YT IT Y

P 1: AP 1: A
M OM O
UN TUN T

P 2: QP 2: Q
UA NUA N
T IT YT IT Y

P 2: AP 2: A
M OM O
UN TUN T

P 3: QP 3: Q
UA NUA N
T IT YT IT Y

P 3: AP 3: A
M OM O
UN TUN T

100
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7
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0
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29

14 1,27
5.00

91.0
7

4.00 364.
29

100
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The cost roll-up and sales price calculations are known as bill of materials (BOM) calculations, and you initiate

them from the Calculations page. This topic provides information about BOM calculations.

The cost roll-up and sales price calculations are known as bill of materials (BOM) calculations, and you initiate

them from the CalculationsCalculations  page. You use the CalculationsCalculations  page to perform the following tasks:

Calculate the cost of a manufactured item, and generate an associated item cost record within a costing

version.

Calculate the sales price of a manufactured item, and generate an associated item sales price record within a

costing version.

The way that you use the CalculationsCalculations  page varies slightly, depending on how you initiate the BOM

calculations. The way that you use the CalculationsCalculations  page also depends on whether the BOM calculations

involve a costing version for standard costs or planned costs, and on several policies that are defined in the

costing version that is used in the BOM calculations. Note:Note: A variation of the CalculationsCalculations  page is used in the

context of a sales order, sales quotation, or service order line item. These calculations are known as order-

specific BOM calculations. An order-specific BOM calculation doesn't generate an item cost record within a

costing version. Instead, it generates a calculation record that appears on the BOM calculation detailsBOM calculation details  page.

The calculation record includes a calculated cost and a calculated sales price. The CalculationsCalculations  page can be

opened for a single manufactured item or for a costing version:

To calculate costs for a single manufactured item, you initiate BOM calculations from the Item priceItem price page.

The CalculationsCalculations  page inherits the item identifier. The costing version, BOM version, route version,

calculation quantity, calculation date, and site must be specified.

To calculate costs for all manufactured items or selected items, or to update items on a where-used basis, you

initiate BOM calculations from the Costing version setupCosting version setup page or the Costing version maintenanceCosting version maintenance

page. The CalculationsCalculations  page inherits the costing version.

By default, the BOM version and route version are set to the active versions for the item, site, date, and

calculation quantity. However, you can override the default values with approved versions.

By default, the calculation quantity is set to the item's standard order quantity. However, you can

override the default value.

The calculation date or site can be mandated by the costing version, or user-specified values can be set

when the date or site isn't mandated in the costing version. A future calculation date determines how

pending cost records are used. BOM calculations use a pending cost record that has the nearest from-

date that is on or before the calculation date.

For the calculations, it's assumed that the active BOM version and route version are used for a

manufactured item (and for the related site, date, and quantity), unless a manufactured component

has a specified sub-BOM or subroute.

For the calculations, it's assumed that the standard order quantity is used for manufactured items. The

standard order quantity provides the basis for calculating component quantities, determining the

relevant BOM versions and route versions (when you use quantity-sensitive BOMs and routes), and

amortizing constant costs. However, when a manufactured component has a BOM line type of

ProductionProduction or VendorVendor , or when you use a make-to-order explosion mode for the BOM calculations,

this assumption doesn't apply, because quantities reflect the specified calculation quantity.

The calculation date or site can be mandated by the costing version, or user-specified values can be set

when the date or site isn't mandated in the costing version.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/bom-calculations.md


BOM calculations that use standard costsBOM calculations that use standard costs

BOM calculations that use planned costsBOM calculations that use planned costs

Other variations in BOM calculations reflect the costing type and restrictions of the costing version:

BOM calculations that use standard costs must be restricted by costing version policies, because the

restrictions help guarantee that standard costing principles are used. Standard costing principles require the

enforcement of restrictions about the use of standard costs for purchased items, a single-level explosion

mode, and the inclusion of miscellaneous charges in unit costs.

BOM calculations that use planned costs don't have to follow standard costing principles. These BOM

calculations can use different explosion modes, alternative sources of cost data for purchased items, and

optional enforcement of restrictions within the costing version.

Policies within the costing version (for standard costs) can mandate enforcement of five BOM calculation

policies. The Recording restr ictionRecording restr iction option in the costing version mandates one of these policies, where

miscellaneous charges must be included in the unit price. Miscellaneous charges for purchased items can be

entered manually, whereas miscellaneous charges for manufactured items reflect the calculated amortization of

constant costs. The Calculation restr ictionCalculation restr iction option in the costing version mandates the other four BOM

calculation policies:

The source of cost contributions for purchased items must be based on standard costs. In other words, BOM

calculations must use the item cost records within the specified costing version, or within the fallback that

contains standard costs.

To help guarantee accurate and consistent calculation of standard costs, the explosion mode must be single-

level.

To help guarantee consistent results when the sales price of the items is calculated, the profit setting must be

mandated. The profit setting can be used, and the item sales price records can be generated, only if the

costing version allows for content of sales prices.

The fallback principle must be mandated, and can be set to NoneNone, ActiveActive (for active cost records), or

Costing versionCosting version (for a specified costing version).

Policies within the costing version (for planned costs) can optionally mandate enforcement of five BOM

calculation policies. Alternatively, the policies can just provide default values. The Recording restr ictionRecording restr iction option

in the costing version determines whether the BOM calculation policy about miscellaneous charges will be

mandated or act as a default value. Miscellaneous charges can optionally be included in the unit price. The

Calculation restr ictionCalculation restr iction option in the costing version determines whether the other four BOM calculation

policies will be mandated or act as default values:

The source of cost contributions for a purchased item can be the item cost records within a costing version.

Alternatively, the source can be defined by the BOM calculation group that is assigned to the item. For

example, the BOM calculation group can define purchase price trade agreements as the source of cost

contribution data.

The explosion mode can be single-level, multilevel, or make-to-order, or it can be based on the BOM line

item. The explosion mode for the BOM line type replicates the cost calculation logic for production order

estimates.

The profit setting can be mandated, or it can be a default value. The profit setting can be used, and the item

sales price records can be generated, only if the costing version allows for content of sales prices.

The fallback principle can be mandated, or it can be a default value. The fallback principle can be set to NoneNone,

ActiveActive (for active cost records), or Costing versionCosting version (for a specified costing version).

BOM calculations generate warning messages and other types of messages. Several BOM calculation policies

determine the types of messages. The warning conditions are defined in the BOM calculation group that is

assigned to items. However, you can override these warning conditions when you initiate a BOM calculation.

When the fallback principle is used, it's often helpful if the fallback is shown as an information message. When



BOM calculations that use the fallback principle

BOM calculation of a suggested sales price

Order-specific BOM calculations

you're trying to update calculated costs for items that have missing cost records, it's also helpful if the

information message identifies items that weren't updated.

The following situations illustrate two uses of the fallback principle:

Two-version approach to standard cost updatesTwo-version approach to standard cost updates  - A costing version can contain the incremental

changes to standard costs, such as pending cost records that represent new items or cost changes. In this

situation, the fallback principle can identify the use of the active standard costs that are contained in other

costing versions.

S imulation of the effect of cost changes by using planned costsS imulation of the effect of cost changes by using planned costs  - A costing version for planned costs

can contain incremental changes for simulation purposes. This costing version will include pending cost

records that represent the simulated cost changes to items, cost categories, and calculation formulas for

indirect cost. In this situation, the fallback principle can identify the use of the active standard costs that are

contained in other costing versions.

When you use a cost-plus-markup approach, the calculated sales price for an item reflects the set of profit-

setting percentages that is specified for the BOM calculation, and the costs that are associated with the item's

component items, routing operations, and applicable manufacturing overheads. The markup reflects profit-

setting percentages that are assigned to cost groups, and the cost groups that are assigned to items, cost

categories for routing operations, and the indirect cost calculation formulas for manufacturing overheads. The

sets of profit-setting percentages are labeled StandardStandard, Profit 1Profit 1 , Profit 2Profit 2 , and Profit 3Profit 3 . Within the Profit 1 set,

for example, a profit-setting percentage of 50 percent can be defined for a cost group that is assigned to

purchased material, and a profit-setting percentage of 80 percent can be defined for a cost group that is

assigned to cost categories for routing operations. The context of the BOM calculation determines how the

results of a calculated sales price are handled:

BOM calculation for an item and specified costing versionBOM calculation for an item and specified costing version - The BOM calculation generates a

pending sales price record within the costing version. This sales price record provides the starting point for

viewing the calculation details (for example, on the Calculate item costCalculate item cost page). The sales price record acts

mainly as reference information and isn't used as the basis for a sales price on sales orders.

Order-specific BOM calculationOrder-specific BOM calculation - A variation of the BOM calculatioBOM calculation page is used in the context of a

sales order, sales quotation, or service order line item. An order-specific BOM calculation doesn't generate a

record in the within a costing version. Instead, it generates a calculation record that appears on the BOMBOM

calculation resultscalculation results  page. This calculation record provides the starting point for viewing the calculation

details (for example, on the Calculate item costCalculate item cost page). Information about a selected calculation record can

be transferred to the originating line item. For example, the calculated sales price can be transferred to a

sales order line item.

An order-specific BOM calculation represents a variation of a BOM calculation for a manufactured item. The

order-specific BOM calculation is performed in the context of a sales order, sales quotation, or service order line

item. An order-specific BOM calculation generates a calculation record that appears on the BOM calculationBOM calculation

resultsresults  page. The calculation record includes a calculated weight, a calculated cost that is based on active cost

records, and a calculated sales price. The calculation record that each order-specific BOM calculation for an item

generates on the BOM calculation resultsBOM calculation results  page is uniquely identified by a calculation number. The results of a

calculation record can be optionally transferred to the originating line item. An order-specific BOM calculation

differs from a BOM calculation for a manufactured item in two ways:

An order-specific BOM calculation doesn't generate an item cost record within a costing version. Therefore,
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the BOM calculation policies aren't applied when an item cost record is created, or when a cost record is

overwritten.

An order-specific BOM calculation always uses the active cost records for components, cost categories, and

indirect cost calculation formulas.
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Purposes of BOM calculation groups

Calculation groups

Cost price modelCost price model

This article provides information about calculation groups for bills of materials (BOMs) and how to set them up.

To run a BOM calculation, you must either set up calculation groups and assign them to individual items, or set a

default calculation group. The calculation settings from the calculation group are then used as default values on

the BOM calculation page at the time of BOM calculation.

A default calculation group is required on the Inventor y and warehouse management parametersInventor y and warehouse management parameters  page,

or a product-specific calculation group is required on the Released product detailsReleased product details  page. The system first

looks for the calculation group setup on the Released product detailsReleased product details  page. If it doesn't find a calculation

group there, it looks on the Inventor y and warehouse management parametersInventor y and warehouse management parameters  page. If the system can't

find a calculation group, the user receives an error message during calculation. A calculation group contains

policies for the cost price model, the sales price model, and the warnings checklist. The calculation settings from

the calculation group are used as default values on the BOM calculationBOM calculation page at the time of BOM calculation.

You assign a BOM calculation group to items for several reasons:

By setting the Cost pr ice modelCost pr ice model  field, you indicate the source of a purchased component’s cost contribution

data during the calculation of the planned cost of a manufactured item. Some manufacturers calculate

planned costs by using the purchase price trade agreements for purchased components or another basis,

such as the purchase price records in a costing version.

By setting the Sales pr ice modelSales pr ice model  field, you indicate how the item’s data is used to calculate a suggested

sales price. You can specify either the item sales price or the cost group. Some manufacturers want to

calculate a suggested sales price for manufactured items. The calculated sales price can reflect a rolled-price

approach that is based on the component’s sales price record. Alternatively, the calculated sales price can

reflect a cost-plus-markup approach that is based on the component’s cost and applicable profit percentage,

which is associated with the item’s cost group.

By using the Stop explosionStop explosion field, you indicate that a manufactured item should be treated as a purchased

item for cost roll-up purposes during BOM calculation. Typical scenarios include a purchased item that is

occasionally manufactured or a manufactured item that is now being purchased. The item is first designated

as a manufactured item to define BOM and route information, and to support production orders for the item.

However, the Stop explosionStop explosion flag prevents cost calculations from using the item’s BOM and route. Instead,

the BOM calculation uses the item’s specified costs.

You define calculation groups under Predetermined cost policies setupPredetermined cost policies setup in Cost management. Calculation

groups that are assigned to items let you specify how the cost or sales price of components, as outlined by the

calculation group, is sourced for the calculation. On the Calculation groupsCalculation groups  page, you can define a cost price

model, an alternative cost price model, a sales price model, and warnings.

There are four options for the Cost pr ice modelCost pr ice model  field:

Item cost pr iceItem cost pr ice – The cost price from the Released productReleased product table is used, or the combination of item

dimensions is used as the cost price.

Item purchase pr iceItem purchase pr ice – The purchase price from the Cost pr iceCost pr ice field on the PurchasePurchase tab of the ReleasedReleased

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/bom-calculation-groups.md


Alternative cost priceAlternative cost price

Sales price modelSales price model

Stop explosionStop explosion

WarningsWarnings

product listproduct list page is used.

Trade agreementsTrade agreements  – You can configure trade agreements for specific combinations of items and vendors, or

for specific sites. Then, when you select the Trade agreementsTrade agreements  option here, the trade agreement that you

created for the purchase price together with the item and site will be used.

Inventor y pr iceInventor y pr ice – The current inventory value for the item is used to calculate the unit cost in the BOM

calculation. A unit cost price is calculated only if the posted quantity and the physical quantity are more than

0 (zero).

The Alternate cost pr iceAlternate cost pr ice field has the same options as the Cost pr ice modelCost pr ice model  field. However, this field is used

only when a price can't be found in the primary cost price model.

There are two options for the calculation of the Sales pr icesSales pr ices  field:

Cost groupCost group – When this option is selected, the sales price is calculated based on the cost price and the profit

setting percentage from the cost group.

Item sales pr iceItem sales pr ice – When this option is selected, the sales price on the SellSell  FastTab from the Released

product table is used.

The Stop explosionStop explosion check box is used to indicate when a manufactured item should be treated as a purchase

item. Typically, you will leave the Stop explosionStop explosion check box cleared. By selecting this check box, you indicate

that a manufactured item must be treated as a purchase component instead of a manufactured component for

the purpose of BOM calculation. Depending on the site, the item's cost can still be calculated by using BOM

calculations. Explosion of planned purchase orders and production orders is stopped at the BOM whose

components are associated with the calculation group that the Stop explosionStop explosion check box is selected for. Master

scheduling generates the planned orders on the BOM itself, not on the items that are included in the BOM.

Basically, by selecting this check box, you specify that a cost won't be added into the BOM calculation for items

that have this calculation group.

On the WarningsWarnings  FastTab, you select the options for any warning messages that users should receive when they

do BOM calculations.

For example, if you select the No BOMNo BOM check box, the user receives a warning if no active BOM version is found

for one of the components or the parent item that the BOM calculation is run for. If you select the No routeNo route

check box, the user receives a warning if no active route version is found. If you're using resources on your

routes and operations, you can instruct the system to check for those resources. Then, if a resource isn't found

on every line in the active route, the user receives a warning.

You can also verify and check for consumption. Consumption is the quantity in a particular route. Typically, it

represents the amount of time that is required in order to perform a specific operation for a production process.

You can check whether an item has no cost price. If there is no active cost price for an item, no cost is added into

the BOM calculation.

You can also check and verify the age of the cost price. For example, enter 6060  to indicate that the unit cost price

must be reevaluated after 60 days. If this limit is reached, the system generates a warning. For example, a cost

price was entered for an item in January of this year. If it's now August, which is more than 60 days after the cost

price was entered, the user receives a warning when the BOM calculation is run. You can enter in a percentage in

the Minimum contr ibution marginMinimum contr ibution margin field. This value indicates the point at which the minimum contribution

margin isn't being met. If the contribution margin for a particular component isn't met, the user receives a

warning. Therefore, this field helps guarantee that you don't undercut the costs and the additional carrying costs

that might be required for your items.
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View warning messages on the Complete pageView warning messages on the Complete page
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Because calculation groups are required in order to run calculations, you must set up a default calculation group

in the Inventory management parameters. This setup enables companies to have a standard cost group and

profit setting for all items. Then, if a particular item has special calculation requirements, the user can assign a

different calculation group to that item. Typically, you can set calculation groups on BOM component items

instead of BOM items. However, when warning messages are shown, calculation groups can be applied. A

calculation group that is assigned to items overrides the default value that is set up in the Inventory

management parameters.

You can set up the default parameter at Cost managementCost management > Inventor y accounting policies setupInventor y accounting policies setup >

ParametersParameters  > Inventor y accountingInventor y accounting > Calculation groupCalculation group. By setting up a default configuration group, you

can also configure the warning conditions that prompt users during the BOM calculation process, if the selected

components might cause calculation errors.

A BOM calculation generates warning messages. You can view the warnings about a selected item. For example,

in Sales and marketing, create a new sales order for item D0001. Then, on the sales order line, on the UpdateUpdate

lineline menu, click Calculate Based on BOM/FormulaCalculate Based on BOM/Formula to view the calculation details and warnings. You can also

view BOM calculation results on the CompleteComplete page. For the warning messages, only two warning conditions

apply to manufactured items, whereas four warning conditions apply to any item:

Identify when a manufactured item doesn't have an active BOM.

Identify when a manufactured item doesn't have an active route.

Identify when the item on a BOM line has a quantity of 0 (zero).

Identify when the item on a BOM line has a cost of 0 (zero), or when it doesn't have a cost record.

Identify when the item on a BOM line has an out-of-date cost. The warning reflects a comparison of the

calculation date to the specified days for a maximum age of cost.

Identify when the item on a BOM line has a profitability percentage that is less than you want.

You can define multiple BOM calculation groups, depending on your requirements for variations in warning

messages. For example, one BOM calculation group that has warning conditions about an active BOM, a

component quantity of 0 (zero), and component cost of 0 (zero) might be enough. When you start a BOM

calculation, you can override the warning conditions that are associated with the BOM calculation group. You

can also add or remove warning conditions. For example, if the current situation doesn't involve routing data,

you can remove the warning condition about an active route. Note:Note: Time and attendance includes a

Calculation groupsCalculation groups  page, but that page has no relationship to BOM calculation groups. In Time and

attendance, workers can be assigned to calculation groups that reflect the grouping of workers who are

associated with the same supervisor or manager. Calculation of worker registrations can be done either

automatically or manually by a supervisor or manager.
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NOTENOTE

The bill of materials (BOM) level that is named Cost calculation levelCost calculation level  excludes production orders and batch

orders from its calculations. The system uses this level when it runs cost calculations in costing versions. In

processes such as recalculation and inventory close, the system uses the Costing levelCosting level  BOM level instead.

The following simple scenario shows the differences between the Cost calculation levelCost calculation level  BOM level and the

Costing levelCosting level  BOM level.

You have three products: A, B, and C. Product C is the component of product B, and product B is the component

of product A.

Costing levelCosting level  assigns the following BOM levels:

Product A:Product A: 0

Product B:Product B: 1

Product C:Product C: 2

Cost calculation levelCost calculation level  assigns the following BOM levels:

Product A:Product A: 0

Product B:Product B: 1

Product C:Product C: 2

A production order for product C is then created, and product A is added to the production order BOM. After the

order is estimated, BOM levels are updated in the following way:

Costing levelCosting level  assigns the following BOM levels:

Product B:Product B: 1

Product C:Product C: 2

Product A:Product A: 3

Cost calculation levelCost calculation level  assigns the following BOM levels:

Product A:Product A: 0

Product B:Product B: 1

Product C:Product C: 2

This behavior ensures that changes to production order BOMs don't affect subsequent cost calculations.
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Configuring backflush costing

This topic introduces the concept of backflush costing that is used for Lean manufacturing.

Costing for Lean manufacturing enables the production flow to use the cost accumulation method that is known

as backflush costing. In the backflush costing method, the direct materials that are consumed are accumulated in

the production flow's work in progress (WIP) cost account. The standard cost inventory model group is used.

The products that are received from the production flow are deducted from WIP at their standard cost. The main

difference between backflush costing and standard cost is that, for backflush costing, variances aren't calculated

per kanban or finished product. Instead, variances are calculated per production flow over a period. This method

introduces a truly lean concept for reporting material consumption. Dedicated picked quantities of material

aren't reported to a kanban or production order. Instead, full batches or handling units are staged to the

production flow. After the batches or handling units are registered as empty, they are declared consumed.

Advanced consumption might be used, depending on the configuration of the production flow. Before advanced

consumption can be used, organizations must allow themselves to make material vanish in the WIP of the

production flow. The periodic backflush costing determines the effective value of WIP to the end of the period.

This determination is based on the kanban handling units and the kanban job status. Deviations between the

effective values and the actual WIP values per cost group and item are accounted and shown as variances.

To enable costing, you must complete the following setup:

Set up WIP accounts for the production group and production flow.Set up WIP accounts for the production group and production flow. The WIP accounts for the

production flow are specified in the production group. The backflush costing production flow calculates

variances as the difference in the WIP value before and after backflush costing is run for each production

flow. Therefore, we recommend that you create a WIP account for every production flow.

Assign a cost categor y to the resource group.Assign a cost categor y to the resource group. You must assign a cost category to the run-time

category of the work cell. To determine variances by activity, you should create a cost category for every

work cell. The cost categories for setup and quantity aren't considered in costing for lean manufacturing. The

WIP accounts per resource group are ignored in backflush costing. For subcontracted activities, no cost

category is required. The cost group that is assigned to the active service is used instead.

Assign cost groups.Assign cost groups. To enable segmentation of the cost contribution in a production flow, you must assign

cost groups by cost group type:

Direct mater ial cost groupDirect mater ial cost group - Direct material requires a cost group that identifies the material

category for costing. This cost group enables an aggregated view of cost, WIP, and variances by direct

material.

Direct manufactur ing cost groupDirect manufactur ing cost group - The direct manufacturing cost group captures the direct cost

contribution of operational resources to the production flow. This cost group enables an aggregated

view of cost, WIP, and variances by direct manufacturing cost.

Indirect cost groupIndirect cost group - The indirect cost group is required in order to calculate the indirect cost

contribution to the production flow. This cost group enables an aggregated view of cost, WIP, and

variances by indirect cost.

Direct outsourcing cost groupDirect outsourcing cost group - The cost group for the services enables an aggregated view of

assigned cost and WIP, and determines the cost variances of the subcontracted services.

Cost group for a finished productCost group for a finished product - Finished products require a cost group that identifies the

product category for costing. This cost group enables an aggregated view of cost, WIP, and variances

by product category. The standard cost for products is calculated by using the cost calculation that is

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/backflush-costing.md


Costing sheetCosting sheet

Cost calculation for Lean manufacturing

Calculation that is based on the production flowCalculation that is based on the production flow

Calculation that is based on the routeCalculation that is based on the route

based on the bill of materials (BOM), and either the production flow and kanban rules or the route.

The costing sheet models the cost structure for the company and is built by the cost groups to classify the cost.

The costing sheet has various forms. It shows cost information according to the structure that is designed in it. In

the costing sheet, you also define the formula that is used to calculate the indirect cost. The calculation formula

can be based on quantities, weight, volume, or value.

Define a costing version.Define a costing version. In the costing version, the company defines how the cost should be maintained.

A costing version can contain a set of standard cost records or a set of planned cost records, depending on

the costing type that is assigned to the costing version. The costing version that is used for costing for Lean

manufacturing must be based on standard cost.

Assign an inventor y model group for released products.Assign an inventor y model group for released products. All products that are related to the

production flow must be assigned to an inventory model group that uses the Standard costStandard cost inventory

model group. Standard cost is maintained per site and activation date. For product masters, the inventory

model group can be selected if the cost is maintained per variant or product master.

By definition, subcontracted ser vices are non-inventoried ser vices.By definition, subcontracted ser vices are non-inventoried ser vices. Subcontracted activities have no

inventory model group. To cost a subcontracted activity correctly, you must make sure that the service

activity belongs to an inventory model group where the inventory policy is set to Stocked product = FalseStocked product = False.

For output products, cost calculation that is based on the production flow requires that a standard cost be

maintained for the services that are related to subcontracted activities. The cost group that is assigned to the

services is used to determine the cost variances of the subcontracted activity.

For products that are supplied out of a production flow, the BOM calculation must be based on either a route

version or a production flow. The BOM calculation calculates the cost of a product and the related breakdown to

the resources and material that are required in order to build the product. The deduction from the WIP account

for the production flow is done by using the breakdown of a product by item and cost group.

Lean manufacturing for Dynamics 365 Supply Chain Management is independent of routes. The cost calculation

for products that are supplied from a production flow can be based on the production flow itself. Before the

calculation can be done, a kanban rule must be created that supplies the product out of the production flow. If a

product can be supplied from multiple production flows at the same site on the calculation date, you can select

the production flow for the BOM calculation. On the Default production flowDefault production flow  page, you can configure a

default production flow for each item. If multiple kanban rules exist for the same product in the same production

flow that is active on the calculation date, the calculation selects the first kanban rule that is active for the

calculation.

Calculation that is based on a route is as valid as calculation that is based on a production flow. However,

calculation that is based on a route doesn't use the costing for Lean manufacturing functionality. The route

should use resource requirements for resource groups. To avoid systematic variances, it should also use the

same work cells, or at least the same cost categories. Again, you should avoid cost categories for setup and

quantity. They don't help calculate the cost in a more granular breakdown than Lean manufacturing cost

backflushing. To determine which option (production flow or route) you should use to calculate the cost,

consider the results of the cost breakdown. The version that comes closer to reality and produces fewer

variances overall is the better option. In a Lean manufacturing environment where a product is supplied by a

single production flow and a single kanban rule, the calculation that is based on the production flow is probably

more accurate. For a product that can be supplied by Lean manufacturing and production orders on the same

site, or that can have multiple production flows or multiple kanban rules in the same flow, a calculation might be
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Receiving products from the production flow

Products in WIP

Consuming products in WIP

Automatic empty registrationAutomatic empty registration

more accurate if it's based on a route version that is built specifically for the cost calculation, not for the

production. The production flow calculation must be used to calculate products that involve subcontracting. The

cost models for subcontracting via production orders and subcontracting in Lean manufacturing are using two

different approaches. Lean manufacturing introduces a new cost group type, Direct outsourcingDirect outsourcing, to calculate

subcontracted services.

When material is consumed from inventory to WIP, the cost of material is added to WIP at its actual standard

cost for a cost group. This operation occurs under the following conditions:

Kanban issues are posted for kanban picking lines that update inventory.

Transfer jobs are completed that update inventory on pick but not receipt (Transfer of material from

inventory to WIP).

Products are received from the production flow under the following conditions:

Process jobs are completed that have Update inventor y on receiptUpdate inventor y on receipt set to YesYes .

Transfer jobs are completed that update inventory on receipt, but that have Update inventor y on pick setUpdate inventor y on pick set

to NoNo (Transfer from WIP to inventory). This option lets you receive any products out of a production flow

independently of the BOM and route configuration. The process just follows the physical flows. This option is

especially suitable for receiving by-products, co-products, or scrap out of a production flow, and for

correcting the cost balance of the production flow WIP accordingly.

Products that are received from the production flow are deducted from WIP.

The WIP model of Lean manufacturing lets you use the kanban handling unit status to manage the material,

semi-finished products, and finished products that are part of WIP.

AssignedAssigned - The kanban can have consumed material that is accounted in WIP.

ReceivedReceived - If the kanban refers to a last activity where Update inventor y on receiptUpdate inventor y on receipt is set to NoNo, it

represents a full handling unit of a product or a semi-finished product that isn't registered to inventory.

Note that material in WIP isn't visible in inventory on-hand overviews. However, it's visible in the kanban

quantity overviews.

Products in WIP are consumed when the corresponding kanban handling units are emptied. A kanban empty

signal doesn't produce an active costing transaction but will take effect when the next backflush costing is run.

Emptied kanban handling units are no longer accounted as on-hand and therefore calculated as consumed

within the period.

Scheduled or event kanbans can be set to automatic empty registration in the kanban rule:

When handling units are receivedWhen handling units are received - By default, for scheduled kanbans, the material is declared as

consumed when the last job of the kanban is completed. For fixed quantity kanbans, this option is

recommended only for single-bin kanbans, because it returns the card to the source of demand whenever a

kanban is received at the final destination.

When source requirement is registeredWhen source requirement is registered - This option is available only for event kanbans and is the
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default option for them. In connection to WIP, this option is useful for keeping WIP clean, because kanbans

for components in WIP are automatically emptied, and therefore consumed from WIP, when the parent

kanban is prepared.

In conclusion, kanban handling units can be assigned (= in process), received (=full), or emptied. There is no

partial emptying. Therefore, to enable accurate registration of consumption, it's important that you limit the

product quantities of a kanban so that they are less than the consumption per period. Products that are moved

to the shop floor in big batches that cover days or weeks of demand should not be consumed to WIP. Instead,

these products should be kept in inventory.

You should run backflush costing to periodically value the WIP and produce an end-of-period status that

calculates the variances of material, labor, and indirect costs. The calculated variances are posted to the variance

accounts. In the backflush costing process, all production flows of the legal entity are used in the same batch

run. When backflush costing is run in a batch, the processing might be multi-threaded by production flow. The

backflush period is defined by an end date. You can't post new transactions to a date when a backflush costing

calculation has been run. You should never run backflush costing for the current date before the day is actually

over. Backflush costing performs the following steps.

1. Determine the unused quantities in the production flow as of the period's end date. After the backflush

costing is run, you can view the unused quantities on the date of the costing run in the UnusedUnused

quantitiesquantities  dialog box.

2. Calculate the production flow's net realized usage over the period.

3. Clear the WIP from the realized resource consumption and products.

4. Calculate production variances to standard cost for the period. For consumed components for theFor consumed components for the

period:period:

Financially update the net realized quantities of material that the production flow consumed over the

period. The system processes in first in, first out (FIFO) order on the individual inventory transactions

as to financially update the physically updated transactions for the production flow, until the net

realized quantities for the period are reached.

Transactions are financially split to map the exact consumed quantities.

Unused quantities in the production flow WIP remain in physically updated status.

For production completed quantities of the period:For production completed quantities of the period:

Financially update the inventory transactions for the completed quantities for the period.

For the conversion cost:For the conversion cost:

The applied conversion cost transactions (route transactions) that were recorded for the period are

financially updated.

All direct manufacturing cost is financially updated. All kanban process jobs that are completed during

the period are accumulated.

All indirect cost calculated for the consumed material within the period is calculated and deducted

from WIP. The remaining indirect cost is posted as a variance.

5. Calculate the production variances to standard cost. The variance is calculated per cost group.
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This article explains various typical sources of each type of production variance.

Here are some typical sources of a lot sizelot size variance:

The good quantity for a production order differs from the calculation quantity that is used in the standard

cost calculation. The quantity provides the basis for amortizing constant costs.

The value of constant costs on the production order differs from the constant costs that are used in the

standard cost calculation. The constant costs on the production order can differ for several reasons. For

example, the constant costs might reflect the following factors:

Manual changes to the production bill of materials (BOM) or route

The selection of a different BOM version or route version when you create the production order

Planned engineering changes to the BOM version or route version that is assigned to the item

Here are some typical sources of a production pr iceproduction pr ice variance:

The cost category (and cost category price) for the reported consumption of a routing operation differs from

the cost category that is used in standard cost calculation.

The active cost for the cost category price differs from the cost category price that is used in standard cost

calculation.

Here are some typical sources of a production quantityproduction quantity  variance:

You over-issue or under-issue a material component.

You over-report or under-report the time for a routing operation.

You over-receive or under-receive the good quantity of the parent item, relative to the order quantity.

However, you issue components and report operations completely, based on the order quantity for the

production order.

Here are some typical sources of a production substitutionproduction substitution variance:

You issue a material component that isn't on the production BOM.

You manually add a component to the production BOM and report that component as consumed.

You report an item as consumed but don't manually add it to the production BOM.

You manually add an operation to the production route and report that operation as consumed.

When you create the production order, you select a BOM version that differs from the BOM version that is

used in the standard cost calculation.

When you create the production order, you select a route version that differs from the route version that is

used in the standard cost calculation.
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This article provides information about cost categories that apply to manufacturing environments that use

routing.

Cost categories apply to manufacturing environments that use routing. They are assigned to operations

resources and routing operations to define hourly costs and to segment cost contributions in a manufactured

item’s calculated costs. The cost groups that are assigned to cost categories classify manufacturing cost

contributions, based on the operation resources and the type of activity, such as setup time and run time. The

specificity of cost group assignments enables manufacturing overhead to be calculated based on routing

information.

Note:Note: In manufacturing environments, cost categories are known by several other names, such as labor rate

codes or machine rate codes.

Each cost category has associated cost records and an assigned cost group. Different cost categories are

required for different production purposes.

Assign different hourly costs, depending on the operations resource. For example, the costs can differ for

various types of labor skills, machines, or manufacturing cells.

Assign different hourly costs for the setup time or run time that is associated with a routing operation.

Assign operations resource costs based on the output quantity instead of hourly costs, such as the piece rates

for paying labor.

Provide cost group segmentation of cost contributions to a manufactured item’s calculated cost. For example,

you can segment of labor and machine costs.

Provide the cost group basis for overhead calculation formulas, such as formulas for labor-related and

machine-related overhead, or overhead that is related to setup and run time.

A cost category can be assigned to the setup time, the process time, and the quantity for a routing operation.

When, for example, costs or cost group segmentation differs between the setup time and the process time,

different cost categories should be defined and assigned to the setup time and the process time. The selective

use of cost categories for setup time, process time, and quantity is determined by the route group that is

assigned to an operation. The assignment of cost categories to time and quantity can be mandated by company-

wide policies that are defined on the Production control parametersProduction control parameters  page.

Each cost category has associated costs that are based on the definition of cost records in a costing version. Use

the Cost categor y pr iceCost categor y pr ice page to define the cost records for a specified costing version and site. When the cost

record for a cost category is first entered, it has a status of PendingPending and an intended effective date. When you

activate the cost record, the status is updated to Current activeCurrent active, and the effective date is updated to the

activation date. Different cost records might reflect different sites, effective dates, or statuses. Bills of materials

(BOM) calculations for a future or historical date use cost records that have the relevant effective date. The

current active cost record will be used to estimate production order costs and to value reported time against a

production order.

The cost record for a cost category can be site-specific or company-wide. To make a cost record site-specific,

assign a site to it. Otherwise, a blank value indicates that the cost record applies to all sites in the company.

Because costs can differ between sites, for example, the cost records must be defined as site-specific.

A routing operation generally inherits the cost categories that are assigned to the operations resource or master

operation. When a production order is created, the routing operations in the production route reflect the
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selected route version. You can override the cost categories that are assigned to the operations in the production

route.

Some types of production work can apply to project time estimates and reporting. In this case, a cost category is

required for production and project purposes. You must define additional project-related information when a

cost category is flagged for use in projects.
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Some types of production work can apply to project time estimates and reporting. This article provides

information about the cost categories that you must define for these types of production work for production

and project purposes.

Some types of production work can apply to project time estimates and reporting. In this case, a cost category is

required for production and project purposes. When a cost category is used in production and projects,

additional project-related information must be defined. For example, the hourly costs that are associated with

projects can differ from the hourly costs that are associated with production. You can use the Cost categoriesCost categories

page to define a cost category that is used in Production control and Project management accounting.

Note:Note: Cost accounting has a Project categoriesProject categories  page, but this page has no relationship to the functionality

that is described in this topic. When you use a cost category in projects, the Cost categoriesCost categories  page has

additional tabs that show additional project-related information. This information includes the category group, a

line property, and ledger accounts that are assigned to the cost category.

The cost category must be assigned to a category group that supports a transaction type of HoursHours .

The line property indicates default information about how reported time can be charged to a project.

Typically, the ledger accounts that are related to costs and sales are defined for the category group that is

assigned to the cost category. However, specific accounts can be defined for an individual cost category.

Additional buttons on the Cost categoriesCost categories  page let you access project-related information about a selected

cost category. For example, you can view project-related transactions, define employees or projects, define

hourly costs and sales prices, and view reports.
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The constant costs of a manufactured item reflect the operation setup times and the components that have a

constant quantity or a constant scrap amount.

The calculated amount of an item's charges can be displayed with the item's unit costs. However, the charges are

sometimes displayed as separate fields, and they are not included in the item's unit costs. When the charges

appear as separate fields, one field displays the total amount of charges, and another field displays the costing

lot size that is used to amortize the amount. The Item price page, for example, displays the charges as two

separate fields. However, the Complete page displays the item's total cost per unit, and the amortized costs are

included in the unit costs.

The charges for a manufactured item are always included in the item's unit cost for standard cost purposes. They

can optionally be included for planned cost purposes. A policy in the costing version enforces the inclusion of

charges in the cost of a manufactured item. When you activate an item's cost record, you update the charges for

the item's base cost information, which is displayed in the Item price page. The charges are displayed as two

separate fields, and they are not included in the item's unit cost. Each activation updates the item's base cost

information, even if the activation reflects different sites. Therefore, you should view the base cost information

as reference information.
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Variance analysis for a completed production order

This article provides information about the cost analysis that you can do for completed and current production

orders. You can analyze the estimated costs and actual costs by using the Price calculation page or the Cost

estimates and costings report. You can view information about the estimated and actual costs (and quantity) for

each component item, the routing operation, and the indirect cost.

The actual costs for a production order are based on the reported consumption of material and routing

operations. You can access detailed transactions about the reported consumption of material, routing

operations, and indirect costs for a production order on the Production postingProduction posting page.

The variances reflect a comparison of the reported production activities and the calculation of standard costs for

the production item. The variances don't reflect a comparison to the production order's estimated costs. The

production activities that are reported include the consumption of material and routing operations, together

with the associated indirect costs, and the quantity that is reported as finished. The following four types of

variance are calculated:

Lot size variance

Production quantity variance

Production price variance

Production substitution variance

The following diagram shows the four variances that account for the difference between a production order's

actual costs and the calculated costs within the item's cost record when the production order is ended.

You can analyze the production variances by using the VarianceVariance page or the Production var ianceProduction var iance report. Use

the display options to view detailed variances by item and operations resource, or by cost group. The policy for

cost breakdown in the inventory parameters determines whether the variances are tracked by cost group. You

can also use the singlesingle, multimulti , and totaltotal  display options to view summarized variances. The information about

detailed variances can help you understand the source of each variance. To predict variances before you end a
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production order, analyze the detailed information that is provided on the Cost estimates and costingsCost estimates and costings

report.

Separate reports provide information about each type of transaction. Use these reports to analyze costs for

reported production activities. Information is displayed only for current production orders that have a status of

Star tedStar ted or Repor ted as finishedRepor ted as finished.

Mater ials in processMater ials in process  − This report lists the picking list transactions that are reported against the current

production orders as of a specified transaction date. The report indicates the quantity of a component that

was issued and the cost amount for each transaction. Use the selection criteria for a single component item.

For example, you can print information about the component’s issued quantity against applicable production

orders. The issued quantity isn't updated by the quantities that are reported as finished for the parent item.

Therefore, the actual quantity of raw materials in process might be overstated.

Work in processWork in process  − This report lists route transactions (or job transactions) that are reported against the

current production orders as of a specified transaction date. The report indicates the hours, amount, and

quantity (both good quantity and error quantity) that are reported for each transaction. It also includes

information such as the operation number, operation ID, and operations resource. Additionally, this report

shows the total time and amount for all transactions against the production order, and the quantity that is

reported as finished.

Indirect costs in processIndirect costs in process  − This report lists the indirect costs that have been incurred against production

orders. This data is based on reported consumption of routing operations and components as of a specified

transaction date. The report indicates the type of indirect cost (surcharge or rate), the costing sheet code for

the indirect cost, and the cost amount for each transaction. This report doesn't provide information about the

route card or pick list transaction that generated the indirect cost.

In process production costingIn process production costing − This report lists the combined consumption of material, routing

operations, and indirect cost against the production orders as of a specified transaction date.

Finished items in processFinished items in process  − This report lists current production orders and the report-as-finished

transactions as of a specified transaction date.

Common sources of production variances
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Production cost estimation

View the estimated costs

Other uses of cost estimation

This article provides information about production cost estimation. Production cost estimation provides the

projected material and capacity consumption costs of producing an item in the planned production order

quantity.

After you create a production order, you must estimate production costs. The purpose is to estimate item and

route consumption for the production process, because these estimates are used as the basis for subsequent

scheduling and production processes.

Estimates of production costs are based on the following information:

The quantity on the production order

The components on the production bills of materials (BOMs)

The routing operations in the production route

The indirect costs that apply to the components and operations

The active cost data as of the calculation date

If there is a phantom line item on the production BOMs, the calculations reflect the phantom’s components and

route operations. You can use the estimation task to recalculate estimated costs so that they reflect updated

information. For example, the updated information might be changes to the quantity on the production order,

the components on the production BOMs, the routing operations in the production route, the indirect costs that

apply to these components and operations, or the active cost data as of the recalculation date. The calculations

of estimated cost also suggest a sales price for the production item, based on a cost-plus-markup approach. The

calculations of estimated cost can optionally apply to reference orders that reflect other production orders that

are linked to the production order.

After you run estimation, you can view the results on the Pr ice calculationPrice calculation page. The estimation calculates the

following values:

Production costProduction cost – The production cost is the top line of the estimate. It shows the complete cost of running

the production order and the total sales price for the production. It's the sum of all the cost lines on the

estimate.

Route or resource costsRoute or resource costs  – Route or resource costs are the costs for the production operations. They

include the cost of elements such as setup time, run time, and overhead.

Mater ial costsMater ial costs  – Material costs are the costs and prices of the BOM components that are required in order

to produce the item. These costs have previously been established and entered into the system.

A cost estimate also provides the following information:

Meaningful price quotations

Estimates of the profitability of the order

Estimates of raw material usage
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Comparisons of cost information from previous productions

Budget and forecasting information

Estimates of the production size that is required in order to maintain a particular cost
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This procedure shows how to view WIP statement on a production order. The demo data company used to

create this procedure is USMF. This procedure is intended for the cost controller.

1. Click Cost administration.

2. Click Production orders.

3. Use the Quick Filter to filter on the Production field with a value of 'p000153'.

4. On the Action Pane, click Manage costs.

5. Click Production WIP statement.

6. In the From date field, set the date to '2012-12-01'.

7. In the To date field, set the date to '2012-12-31'.
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This procedure shows how to view reasons for high production variance for a production order. The demo data

company used to create this procedure is USMF. This procedure is intended for the cost controller.

1. Click Cost administration.

2. In the Date field, enter or select a value.

3. Click the High production variances tab.

4. Click to follow the link in the Production field.

5. On the Action Pane, click Manage costs.

6. Click View cost comparison.

7. Click Close.

This procedure uses the fiscal year 2012. You can set From date to January 1, 2012 and To date to

December 31, 2012.

Click P000116 to follow the link in the Production field.
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Material consumption

Time consumption

Reporting finished goods and error quantities

Ending the production order

Controlling the level of ledger posting

This article provides information about different types of postings in the production process.

Production posting activities follow production processes that are described in the sections below.

Materials are registered as consumed during production when the production picking list journal is posted. This

process generates issue transactions that deduct the on-hand inventory. In the production parameters, you can

specify whether the value of raw materials that are in progress (work in process [WIP]) should be posted in the

ledger. The value of raw materials that are in progress (WIP) is then posted to a dedicated Picking list account

and a dedicated Picking list offset account.

The time that workers spend on production jobs is recorded in the Route card journal or the Job card journal.

When these journals are posted, ledger posting to a dedicated account for resources that are in progress (WIP)

is processed. This posting represents the value of the time that is spent on the production order. After the

production order is registered as ended, the WIP accounts are settled.

When a production order is reported as finished, the quantity of the finished goods that have been completed is

updated in Inventory management through the Report as finished journal. If you're using WIP accounting, which

can be set up in the production parameters, a ledger journal is made to reduce the WIP accounts and increase

the inventory of the finished goods. The journal uses the standard cost that is defined for the product.

Before a production order is ended, actual costs are calculated for the quantity that was produced. All estimated

costs of material, labor, and overhead are reversed and replaced with actual costs. The overall cost of the

finished item is debited from the inventory Receipt account and credited to the inventory Issues account. If you

select the End jobEnd job check box when you run the cost calculation, the status of the production order is changed to

EndedEnded. This status prevents any additional costs from being unintentionally posted to a completed production

order. You can specify that the value of error quantities that are reported during reporting as finished should be

allocated to the good quantities that are reported as finished. Alternatively, you can specify that the value of

error quantities should be posted to a dedicated scrap account.

In the Production control parametersProduction control parameters , you can use the Ledger postingLedger posting field to set the level of ledger

posting for production processes. The following values are available:

Item and resourceItem and resource – Use the ledger accounts that are set up on the item groups for raw materials and

finished goods. WIP for time consumption is taken from resource or resource group from the route

operations.

Item and categor yItem and categor y  – Use the ledger accounts that are set up on the item groups for raw materials and

finished goods. WIP for time consumption is taken from the cost categories that are associated with the route
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operations.

Production groupsProduction groups  – Use the ledger accounts that are set up on the production groups for both material

and time consumption. The production groups are associated with the released products and copied to the

production orders when those orders are created. The posting on the production orders will then follow the

production groups that are associated with the production order.

Note:Note: If the standard method for calculating the cost of the finished item was used, the final transactions reflect

this fact. If actual costs and the costs that are calculated by using the standard method differ, the difference is

posted to the account that shows profit or loss.
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Products can be sourced in various ways - they can be produced (manufactured) or procured (purchased). This

article describes some typical points to consider when you configure products to support multi-sourcing.

Multi-sourcing is typically used for a purchased item that is occasionally manufactured, or when an item that

was primarily a manufactured item is changed so that it's now primarily a purchased item. The item is first

designated as a manufactured item, so that bill of materials (BOM) and route information can be defined, and to

support production orders for the item. The production type should be set to BOMBOM (or, for process

manufacturing, FormulaFormula or Co-ProductCo-Product).

When you use standard cost, the item cost record can be calculated for the manufactured item. However, the

item cost record might not match the standard cost that you want for purchasing purposes. In this case, the

standard cost must be manually entered and activated for the item cost record. For the cost calculation, consider

using a special BOM and route that represent the supply mix of the product over the course of a fiscal period, to

minimize the variances over time. Additionally, a manufactured item at one site can be transferred to another

site. Therefore, the item's cost must be manually entered and activated for the site that the item is transferred to.

When you use the manufactured item as a component in higher-level products, the component's costs should

be treated as a purchased item. This guideline applies, regardless of whether the component’s costs were

calculated or manually entered. In other words, a BOM calculation should treat the item's costs as a purchased

component instead of using the item's BOM and route information to calculate costs.

To prevent the calculation from occurring, select the Stop explosionStop explosion flag that is embedded in the BOM

calculation group that is assigned to the item. To prevent master scheduling calculations from exploding

requirements through the item, set the explosion fence to 0 (zero) days in item coverage or in the coverage

group. The master scheduling calculation will then treat the item as a purchased item and won't perform more

calculations for the item's BOM and route information.
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Using TCA for coproducts

Total cost allocation (TCA) is a method of calculating the cost between the main formula item for a batch order

and the co-products that are defined for the formula. This method is dynamic. It calculates the cost as a

weighted average between the quantities that are reported as finished for the formula item and the co-products.

When TCA is used, you don't have to review cost allocations for every batch order. If TCA isn't used, the formula

calculation uses existing functionality.

Here are some of the guidelines for using TCA for co-products:

If you set the Total Cost AllocationTotal Cost Allocation slider to YesYes  for a formula version, co-products must have a cost

price that is more than 0 (zero). The value can be retrieved from the active cost version for the same site,

or for the first site for a formula that isn't site-specific. This condition is validated when the formula is

approved.

You don’t need to manually enter cost allocation percentages for co-products. Instead, the system

automatically creates the cost allocation percentage as the average of active cost prices of co-

products.

You don’t need to enter standard cost for non-standard cost items that are co-products. There are two

types of costing versions in the system: standard cost and planned cost

If an item isn’t valuated by the standard cost valuation method, we recommend you use an active cost

price in the planned cost version. This price is used for cost estimation, for example, BOM calculation,

production cost estimation, and fallback price in the inventory valuation process.

If you set the Total Cost AllocationTotal Cost Allocation slider to YesYes  for the formula version and the following conditions

are true, the method of cost allocation is TCATCA, and the percentage of cost allocation is unchanged:

You added co-products.

You used a different method of cost allocation for the co-products.

If you set the Total Cost AllocationTotal Cost Allocation slider to NoNo for the formula version and the following conditions

are true, the method of cost allocation is changed to ManualManual , and the percentage of cost allocation is

unchanged:

You added co-products.

The percentage of cost allocation is more than 0 (zero).

Before you can successfully perform a formula calculation, you must estimate the percentages of cost

allocation. You can complete this step either manually or by using the Estimate costEstimate cost option on the Co-Co-

productsproducts  page. Note:Note: The Estimate costEstimate cost option is available only when the Total Cost AllocationTotal Cost Allocation

slider is set to YesYes  for the formula version. You can view the expected allocation if the batch order

quantities that are reported as finished match quantities that appear on the formula.

When a batch order is created manually or a planned batch order is firmed, the value of the Total CostTotal Cost

AllocationAllocation slider for the formula version is copied to the batch order. However, you can change this

setting on the batch order. If the Total Cost AllocationTotal Cost Allocation slider is set to NoNo for the formula version and

then changed to YesYes  for the batch order, the method of cost allocation for each line that was set to

ManualManual  is changed to TCATCA. A cost allocation of NoneNone is unchanged. If the Total Cost AllocationTotal Cost Allocation slider

is set to YesYes  for the formula version and then changed to NoNo for the batch order, the method of cost

allocation for each co-product of the ProductionProduction type is changed to ManualManual . Any estimated percentage
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of cost allocation is unchanged.

The Co-product cost allocationCo-product cost allocation page shows the calculated cost allocation percentage. You can open

this page from the Batch orderBatch order  page. This information is useful when the products and quantities that

are reported differ from the scheduled or started quantities on the batch order. When the cost is

complete, these new percentage allocations from TCA are shown on the Co-product cost allocationCo-product cost allocation

page.

The By-product cost allocationBy-product cost allocation field on the Co-productsCo-products  page is an enumerator field that is used only for

by-products. For co-products, the value of this field is always NoneNone. For by-product lines, this field determines

how the cost amount for the by-product line is added to the total cost of the production. The following options

are available:

NoneNone ─ No amount is added to the total cost of the production for this by-product line.

PercentPercent ─ The cost amount is calculated as a percentage of the total cost of raw materials that are consumed

in the production. The percentage that is used for the calculation is entered in the field.

Per ser iesPer ser ies  ─ The cost amount is calculated as an amount per standard batch size of the production order.

This amount is independent of the reported quantity in the production. The amount that is used for the

calculation is entered in the field.

Per quantityPer quantity  ─ The cost amount is calculated as an amount per reported quantity of the formula item in the

production. The amount that is used for the calculation is entered in the field.
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A manufactured item’s constant costs reflect the operation setup times and the components that have a constant

quantity or a constant scrap amount.

The concept of a costing lot size is used to amortize these constant costs in the calculated cost of a

manufactured item. This concept has several synonyms, one of which is accounting lot size. The concept of

amortizing constant costs also has several synonyms, one of which is proportional constant costs.

The quantity of a costing lot size for a manufactured item is used in a bill of material (BOM) calculation. The

quantity depends on how you initiate and perform the BOM calculation, as illustrated by the following:

Default calculation quantity in an item’s BOM calculation − The item’s standard order quantity for inventory

acts as the costing lot size, but the default value might be a greater quantity to reflect the item’s order

quantity multiple. The item’s standard order quantity and multiple can be defined within its default order

settings or site-specific order settings.

Specified calculation quantity in an item’s BOM calculation − The specified calculation quantity acts as the

costing lot size for the item. The calculation quantity initially uses the item’s standard order quantity, but the

default value can be manually overridden. The specified calculation quantity represents the costing lot size

for the specified item, and for manufactured components that have a BOM line type of production. This is

because it is assumed that the component will be produced to the exact quantity. The costing lot size for

other manufactured components that have a BOM line type of item will reflect their standard order quantity.

Specified make-to-order calculation quantity in an item’s BOM calculation − The specified calculation

quantity acts as the costing lot size for the item and its manufactured components when BOM calculations

use a make-to-order explosion mode. It is assumed that the manufactured components will be produced to

the exact quantity, just like a manufactured component that has a BOM line type of production.

Specified calculation quantity in an order-specific BOM calculation − An order-specific BOM calculation can

be performed for a line item on a sales order, sales quotation, or service order. The specified calculation

quantity uses the quantity on the originating line item, but the default quantity can be overridden. You can

select whether the order-specific BOM calculation uses a make-to-order or multilevel explosion mode.

The calculated amount of a manufactured item’s amortized constant costs is termed charges.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Overview

NOTENOTE

Accessing the Power BI content

Report pages that are included in the Power BI content

The Cost managementCost management Microsoft Power BI content is intended for inventory accountants or individuals in the

organization who are responsible for or interested in the status of inventory or work in progress (WIP), or who

are responsible for or interested in analyzing standard cost variances.

The Cost managementCost management  Power BI content described in this this topic applies to Dynamics 365 Finance and Operations

8.0.

The Cost managementCost management  Power BI content pack, available on the AppSource site, has been deprecated. For more

information about that deprecation, see Removed or deprecated features for Finance and Operations.

This Power BI content provides a categorized format that helps you monitor the performance of inventories and

visualize how cost flows through them. You can gain managerial insights such as the turnover ratio, number of

days that inventory is on hand, accuracy, and "ABC classification" at your preferred aggregated level (company,

item, item group, or site). The information that is made available can also be used as a detailed supplement to

the financial statement.

The Power BI content is built on the CostObjectStatementCacheMonthlyCostObjectStatementCacheMonthly  aggregated measurement, which

has the CostObjectStatementCacheCostObjectStatementCache table as its primary data source. This table is managed by the Data set

cache framework. By default, the table is updated every 24 hours, but you can change the update frequency or

enable manual updates in the configuration of the data set cache. Manual updates can be run in either the CostCost

administrationadministration workspace or the Cost analysisCost analysis  workspace.

After every update of the CostObjectStatementCacheCostObjectStatementCache table, the CostObjectStatementCacheMonthlyCostObjectStatementCacheMonthly

aggregated measurement must updated before data in the Power BI visualizations is updated.

The Cost managementCost management Power BI content is shown in the Cost administrationCost administration and Cost analysisCost analysis

workspaces.

The Cost administrationCost administration workspace contains the following tabs:

Over viewOver view  – This tab shows application data.

Inventor y accounting statusInventor y accounting status  – This tab shows Power BI content.

Manufactur ing accounting statusManufactur ing accounting status  – This tab shows Power BI content.

The Cost analysisCost analysis  workspace contains the following tabs:

Over viewOver view  – This tab shows application data.

Inventor y accounting analysisInventor y accounting analysis  – This tab shows Power BI content.

Manufactur ing accounting analysisManufactur ing accounting analysis  – This tab shows Power BI content.

Std. cost var iance analysisStd. cost var iance analysis  – This tab shows Power BI content.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/cost-management-content-pack.md


Inventory accounting statusInventory accounting status

REP O RT  PA GEREP O RT  PA GE VISUA L IZ AT IO NVISUA L IZ AT IO N

Inventory overview Beginning balance

Net change

Net change %

Ending balance

Inventory accuracy

Inventory turnover ratio

Days inventory on-hand

Active product in period

Active cost objects in period

Balance by item group

Balance by site

Statement by category

Net change by quarter

Inventory overview by site and item group Inventory accuracy by site

Inventory turnover ratio by site

Inventory ending balance by site

Inventory accuracy by item group

Inventory turnover ratio by item group

Inventory ending balance by site and item group

Inventory statement Inventory statement

Inventory statement by site Inventory statement by site

Inventory statement by product hierarchy Inventory statement

Inventory statement by product hierarchy Inventory statement by site

The Cost managementCost management Power BI content includes a set of report pages that consist of a set of metrics. These

metrics are visualized as charts, tiles, and tables.

The following tables provide an overview of the visualizations in the Cost managementCost management Power BI content.



REP O RT  PA GEREP O RT  PA GE VISUA L IZ AT IO NVISUA L IZ AT IO N

Manufacturing accounting statusManufacturing accounting status

REP O RT  PA GEREP O RT  PA GE VISUA L IZ AT IO NVISUA L IZ AT IO N

WIP overview YTD Beginning balance

Net change

Net change %

Ending balance

WIP turnover ratio

Days WIP on-hand

Active cost object in period

Net change by resource group

Balance by site

Statement by category

Net change by quarter

WIP statement Beginning balance

Ending balance

WIP statement by category

WIP statement by site Beginning balance

Ending balance

WIP statement by category and site

WIP statement by hierarchy Beginning balance

Ending balance

WIP statement by category hierarchy

Inventory accounting analysisInventory accounting analysis

REP O RT  PA GEREP O RT  PA GE VISUA L IZ AT IO NVISUA L IZ AT IO N

Inventory details Top 10 resources by ending balance



Top 10 resources by net change increase

Top 10 resources by net change decrease

Top 10 resources by inventory turnover ratio

Resources by low inventory turnover ratio and ending
balance above threshold

Top 10 resources by low accuracy

ABC classification Inventory ending balance

Consumed material

Sold (COGS)

Inventory trends Inventory ending balance

Inventory net change

Inventory turnover ratio

Inventory accuracy

REP O RT  PA GEREP O RT  PA GE VISUA L IZ AT IO NVISUA L IZ AT IO N

Manufacturing accounting analysisManufacturing accounting analysis

REP O RT  PA GEREP O RT  PA GE VISUA L IZ AT IO NVISUA L IZ AT IO N

WIP trends WIP ending balance

WIP net change

WIP turnover ratio

Std. cost variance analysisStd. cost variance analysis

REP O RT  PA GEREP O RT  PA GE VISUA L IZ AT IO NVISUA L IZ AT IO N

Purchase price variance (Std. cost) YTD Procured balance

Purchase price variance

Purchase price variance ratio

Variance by item group

Variance by site

Purchase price by quarter



Purchase price by quarter and Item group

Top 10 resources by unfavorable purchase price ratio

Top 10 resources by favorable purchase price ratio

Production variance (Std. cost) YTD Manufactured cost

Production variance

Production variance ratio

Variance by item group

Variance by site

Production variance by quarter

Production variance by quarter and variance type

Top 10 resources by unfavorable production variance

Top 10 resources by favorable production variance

REP O RT  PA GEREP O RT  PA GE VISUA L IZ AT IO NVISUA L IZ AT IO N

Understanding the data model and entities

O B JEC TO B JEC T
KEY  A GGREGAT EKEY  A GGREGAT E
M EA SUREM EN T SM EA SUREM EN T S

DATA  SO URC E F O RDATA  SO URC E F O R
F IN A N C E A N D O P ERAT IO N SF IN A N C E A N D O P ERAT IO N S F IEL DF IEL D

CostObjectStatementCache
Monthly

Amount CostObjectStatementCache Amount

CostObjectStatementCache
Monthly

Quantity CostObjectStatementCache Qty

CostInventoryAccountingKP
IGoal

AnnualInventoryTurn CostInventoryAccountingKP
IGoal

AnnualInventoryTurn

CostInventoryAccountingKP
IGoal

InventoryAccuracy CostInventoryAccountingKP
IGoal

InventoryAccuracy

Data from the application is used to fill the report pages in the Cost managementCost management Power BI content. This data

is represented as aggregate measurements that are staged in the entity store, which is a Microsoft SQL Server

database that is optimized for analytics. For more information, see Power BI integration with Entity store.

The key aggregate measurements of the following objects are used as the basis of the Power BI content.

The following table shows the key calculated measurements in the Power BI content.



M EA SUREM EA SURE C A L C UL AT IO NC A L C UL AT IO N

Beginning balance Beginning balance = [Ending balance]-[Net change]

Beginning balance qty. Beginning balance qty. = [Ending balance qty.]-[Net change
qty.]

Ending balance Ending balance = (CALCULATE(SUM([Amount]),
FILTER(ALL(FiscalCalendar)
,FiscalCalendar[MONTHSTARTDATE] <=
MAX(FiscalCalendar[MONTHSTARTDATE]))))

Ending balance qty. Ending balance qty. = CALCULATE(SUM([QTY]),
FILTER(ALL(FiscalCalendar),FiscalCalendar[MONTHSTARTDAT
E] <= MAX(FiscalCalendar[MONTHSTARTDATE])))

Net change Net change = SUM([AMOUNT])

Net change qty. Net change qty. = SUM([QTY])

Inventory turnover ratio by amount Inventory turnover ratio by amount = if(OR([Inventory
average balance] <= 0, [Inventory sold or consumed issues]
>= 0), 0, ABS([Inventory sold or consumed
issues])/[Inventory average balance])

Inventory average balance Inventory average balance = (([Ending balance] + [Beginning
balance]) / 2)

Days inventory on-hand Days inventory onhand = 365 /
CostObjectStatementEntries[Inventory turnover ratio by
amount]

Inventory accuracy Inventory accuracy by amount = IF([Ending balance] <= 0,
IF(OR([Inventory counted amount] <> 0, [Ending balance] <
0), 0, 1), MAX(0, ([Ending balance] - ABS([Inventory counted
amount]))/[Ending balance]))

EN T IT YEN T IT Y EXA M P L ES O F  AT T RIB UT ESEXA M P L ES O F  AT T RIB UT ES

Products Product number, Product name, Unit, Item groups

Category hierarchies (Assigned to role Cost management) Category hierarchy, Category level

Legal entities Legal entity names

Fiscal calendars Fiscal calendar, Year, Quarter, Period, Month

Site ID, Name, Address, State, Country

The following key dimensions are used as filters to slice the aggregate measurements, so that you can achieve

greater granularity and gain deeper analytical insights.
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Functional gaps between the inventory value/aging reports and their
storage versions

Storage reports don't include subtotals, even if they are enabled in the report layoutStorage reports don't include subtotals, even if they are enabled in the report layout

Inventory value storage report doesn't support ledger account informationInventory value storage report doesn't support ledger account information

Warnings or errors are shown when changing a ledger period status
without closing inventory

This topic describes how to fix issues that you might encounter while working with cost management.

The Inventory aging report storage and Inventory value storage report features enable Supply Chain

Management to display large volumes of inventory transactions. In each case, the report results are saved for

browsing and exporting, unlike with the non-storage versions of these reports. However, some functionality that

exists in the non-storage versions of these reports doesn't exist in the storage versions. The following

subsections summarize the differences and provide workarounds.

Subtotals can cause issues when the result is exported, especially if users change the record sequence.

To check the subtotals, you can export the result into Microsoft Excel. Alternatively, if you want to check subtotals

within Supply Chain Management, use Feature management to enable the New grid control and (Preview)

Grouping in grids features, which provide a much more flexible way to see the subtotal for any group by

column. For more information, see Grid capabilities.

You can run the trial balance to get the inventory accounts balance and compare that to the Inventor y valueInventor y value

storagestorage report.

Microsoft introduced the following validations to prevent issues caused by an incorrect period-end process

around costing. If you encounter any of the following error messages, refer to KB 4561987 for more information

about how to resolve these issues.

You are about to execute a Recalculation with a date %1 (10-02-2019). The last registered Recalculation

was executed in a previous period with a date %2 (20-01-2019). No execution of an inventory close with

a date %3 (31-01-2019) matching period end has been registered. Please remember to execute an

inventory close as of %3 (31-01-2019) matching the period end. The valuation of inventories, cost of

goods sold, and variances may not be correct in subledger or general ledger until this has been executed.

You are about to change the status of ledger period %1 to %2. No execution of inventory close with a

date %3 matching period end has been registered. Please execute an inventory close as of %3 matching

the period end before changing the status. The valuation of inventories, cost of goods sold, and variances

may not be correct in subledger or general ledger until this has been executed. Reported from legal entity

%4. For now, it is informational, but you will be required to perform such action in future.

The Account structure %1 has been changed. One or more main accounts %2 no longer exist. These Main

accounts are required by the %3 with a date %4. Please add these Main accounts to the Account structure

%1 before you can resume the %3 job. For now, it is informational, but you will be required to perform

such action in future.

You are about to execute an inventory close with a date %1 (31-01-2019). No execution of backflush

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/troubleshoot-costmanagement.md
https://fix.lcs.dynamics.com/Issue/Details?kb=4561987&bugId=445351&dbType=3&qc=f514f2adcddcddceec43af58c26ae8a9020effdc7cdfe085d9d0deeb8cc7b6a3


Inventory aging report discrepancies

An update conflict occurs when the inventory valuation method is
either Standard cost or Moving average

costing calculation with a date %2 (31-01-2019) matching period end has been registered. Please

remember to execute a backflush costing calculation with a date of %3 (31-01-2019) matching period

end. The valuation of inventories, cost of goods sold, and variances may not be correct in subledger or

general ledger until this has been executed.

You are about to execute a backflush costing calculation with a date %1 (28-02-2019). The last registered

backflush costing calculation was executed in a previous period with a date %2 (31-01-2019). No

execution of an inventory close with a date %3 (31-01-2019) matching a period end has been registered.

Please remember to execute an inventory close as of %3 (31-01-2019) matching a period end. The

valuation of inventories, cost of goods sold and variances may not be correct in subledger or general

ledger until the inventory close has been executed.

The Inventor y aging repor tInventor y aging repor t shows different values when viewed at different storage dimensions (such as site

or warehouse). For more information about the reporting logic, see Inventory aging report examples and logic.

When you post documents such as inventory journals, purchase order invoices, or sales order invoices in

parallel for scalability and performance, you might receive an error message about an update conflict, and some

of the documents might not be posted. This issue can occur when the inventory valuation method is either

Standard cost or Moving average. Both these methods are perpetual costing methods. In other words, the final

cost is determined at the time of posting.

If you're using the Moving average method, the error message resembles this example:

Inventory value xx.xx is not expected after the proportional expense calculation

If you're using the Standard cost method, the error message resembles this example:

The standard cost does not match with the financial inventory value after the update. Value = xx.xx, Qty =

yy.yy, Standard cost = zz.zz

Until Microsoft releases a solution to fix the issue, consider using the following workarounds to help avoid or

reduce these errors:

Repost the failed documents.

Create documents that have fewer lines.

Avoid decimal values in the standard cost. Try to define the standard cost so that the Pr ice quantityPr ice quantity  field is

set to 1. If you must specify a Pr ice quantityPr ice quantity  value that is more than 1, try to minimize the number of

decimal places in the unit standard cost. (Ideally, there should be fewer than two decimal places.) For

example, avoid defining standard cost settings such as Pr icePrice = 10 and Pr ice quantityPr ice quantity  = 3, because they will

produce a unit standard cost of 3.333333 (where the decimal value repeats).

In a majority of documents, avoid having multiple lines that hold the same combination of product and

financial inventory dimensions.

Reduce the degree of parallelization. (In this case, your system might become faster, because fewer update

conflicts and retries occur.)
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Get started

Analytical workspaces

This topic points you to resources that you can use to learn more about the business intelligence (BI) and

reporting tools that are available.

Information access and reporting

Tech Talk: Reporting options (video)

Finance and Operations: Power BI Analytics & Reporting Services blog (blog)

Workspaces can use rich infographics and visuals that are supported by Microsoft Power BI. These infographics

and visuals include many controls that are provided by third parties. Therefore, workspaces can provide a highly

visual, interactive experience for users.

Users can interact with data by clicking or touching visuals on the page. They can see cause and effect, and do

simple what-if operations without leaving the workspace. Thanks to stunning, interactive visuals, your users will

have fun exploring data and discovering hidden trends.

To learn more, see the following topics:

Embedded Power BI in workspaces

Power BI Embedded integration

Add analytics to workspaces by using Power BI Embedded

Help secure analytical workspaces and reports by using Power BI Embedded

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/bi-reporting-home-page.md
https://www.youtube.com/watch?v=NzZONjKs5xA
https://community.dynamics.com/365/financeandoperations/b/powerbianalyticsandreporting


Business documents and printing

Electronic reporting

Power BI content home page

Reporting solutions are often used to capture and communicate the details of business transactions. Therefore, a

reporting solution must be able to produce physical manifestations of business data by using existing devices,

such as network printers. Examples of business documents include sales invoices, customer statements, and

checks.

To learn more, see the following topics:

Document Reporting Services

Document printing overview

Install the Document Routing Agent to enable network printing

Electronic reporting (ER) is the tool that you use to configure electronic document formats that comply with the

legal requirements of various countries or regions. The applications of electronic reporting include financial

auditing, tax reporting, and electronic invoicing.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/image-of-business-documents.png


Financial reporting

Technical reference reports

To learn more, see the following topics:

Electronic reporting (ER) overview

MManage the Electronic reporting (ER) configuration lifecycle

Create Electronic reporting (ER) configurations

Standard financial reports are provided that use the default main account categories. You can use the report

designer to create or modify traditional financial statements, such as income statements and balance sheets. You

can then share the results with other members of your organization. Examples of financial reporting include

balance sheets, cash flow, and summary trial balance year over year.

To learn more, see the following topics:

Financial reporting

Generate financial reports

Financial report components

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/electronic-reporting-example.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/financial-reporting-example.png
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/financial-reporting-intro
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/generate-financial-report
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/financial-report-components
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The following reports provide reference information about the objects:

Find information about standard data entities

License codes and configuration keys report

SQL Server Reporting Services (SSRS) reports that are available

Workflow types report

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Why information access is important

What is a "report" in the application?

Common myths of reporting

This topic explains the various reporting options available as part of the platform.

Information access is an essential part of an ERP solution and represents a significant portion of the user

engagement with the system. Consider the numerous methods of capturing information related to daily

activities and the level of investments required to manage the data. Employees depend on logical interpretations

of massive amounts of data to stay on top of their daily tasks. Out of the box the platform provides a collection

of reporting solutions to address the various information access needs of an ERP solution. In an increasingly

competitive environment, mergers and acquisitions seem to occur as often as the change in seasons. More than

ever before, businesses today are finding ways to expand their global reach to attract more customers. To be

successful, they must adapt legacy solutions used to communicate with customers and prepare for the

enforcement of regional regulatory requirements associated with new markets. Beyond the primitive functions

provided by Microsoft Azure – compute, networking, storage, and authentication – the platform provides tools

to manage resources for organizations that span in size from small businesses to global enterprise

conglomerates. These tools are designed with flexibility in mind, to accommodate a dynamic world of business.

A report can be defined simply as a structured presentation of data. Under ideal circumstances, reports

materialize data in such a way that it allows the user to make informed decisions. The application supports a

broad spectrum of information access scenarios: cross company all-up financial reporting; analytical dashboards

and tiles; electronically transferable funds; customer sales invoices; checks and tax documents; and many more.

Examples of integrated report scenarios that involve the consumption of business data include:

Native controlsNative controls  including list pages, grid controls, and chart visualizations.

Dashboards and workspacesDashboards and workspaces  containing predefined and personalized views.

Financial repor tingFinancial repor ting providing all-up views across legal entities.

Structured documentsStructured documents  distributed internally to employees or externally to customers and vendors.

Although each of these scenarios at its core involves the presentation of structured business data, the process of

accessing these reports and how the results are subsequently consumed varies greatly. Flexibility in the user

tooling is essential for scenarios that involve data exploration. By contrast, layout precision is required for

compliance with most regulatory documents. Given the diversity of information access scenarios it's

understandable that not all reports are created equal. This topic is intended to help familiarize you with the

various reporting options available as part of the platform.

To become a proficient report maker, it's often useful to let go of past inhibitions. The following section seeks to

rebuke three common myths about reporting.

Myth #1: Operational repor ts require "real-time" dataMyth #1: Operational repor ts require "real-time" data To the contrary, there are relatively few

reporting scenarios that require real-time results. And, in the grand scheme of things, taking a critical stance

on a request for real-time views is recommended given the high development costs and potential heavy

burden these solutions may incur on production environments.

Myth #2: The best tool is the one the developer is most comfor table usingMyth #2: The best tool is the one the developer is most comfor table using Consider a customer

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/information-access-reporting.md


Understanding report requirements

Reporting experiences

request for a report that allows them to monitor company's assets. In the past, a developer would build a

static report displaying a list of inventory items with complex calculations relying entirely on the user to

provide filters to sufficiently reduce the result set. This solution may function perfectly in developer

environments with a reduced data set. However, this approach is prone to unnecessarily consume significant

amounts of compute resources when utilized in production.

Myth #3: Developers are good at creating visually compelling designsMyth #3: Developers are good at creating visually compelling designs  In reality, developers are the

often the worst offenders when it comes to producing elegant design layouts that will appeal to the

customer's aesthetic preferences. When it comes to analytical reports you're better off empowering users to

both explore the data directly and share personalized views.

The best reporting solutions are designed with the expertise, daily functions, and information access needs of

the target user in mind. The platform offers several tools designed to meet the functional requirements which

are common across various reporting experiences. Without question, selecting the right tool that most

effectively addresses the need requires a clear understanding of the customer experience. You can drastically

increase your chances of delivering a complete and robust solution that fully satisfies customer requirements by

simply asking the right questions. Here are some leading questions to ask when evaluating customer

requirements for reporting solutions:

Get to know the userGet to know the user

What is the proficiency of the target persona? Are they familiar with analytical tools like Microsoft

Excel?

Does the user require a guided parameter experience to refine the dataset?

How frequently will the report be accessed?

Familiar ize yourself with the dataFamiliar ize yourself with the data

Are they looking for transactional, analytical, and/or predictive information?

Does the shape of the data change and if so, how often?

Will the report include data from external sources?

Determine how the results will be usedDetermine how the results will be used

Are you going to explore the data to gain insights?

How will the results be shared with others?

Is there a fixed document structure for the target output?

It's understandable that customers want a solution that aligns with the existing processes they are comfortable

using. However, there's a lot you can learn through these leading questions used to discover what the customer

actually needs to be successful in their task. Delight your customers by providing them with solutions that

empower them to be more productive.

Information access scenarios supported in applications can be broken down into five distinct reporting

experiences. Specialized tools are provided to meet the complex and diverse reporting needs of various

functions throughout the organization.

Operational viewsOperational views  – Designed to address the specific needs of a given business persona.

Business documentsBusiness documents  – Static documents used to capture and exchange processed business data.

Analytical tools and visualizationsAnalytical tools and visualizations  – Personalized presentations of logical calculations that allow the user

to explore their data.

Electronic repor tingElectronic repor ting – Tool used to configure formats for electronic documents.



ScorecardScorecard
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REP O RT IN GREP O RT IN G

F IN A N C IA LF IN A N C IA L
REP O RT IN GREP O RT IN G

Persona Developer Developer Power user Power user Power user

Authoring tool Visual Studio Visual Studio PowerBl.com
PowerBl app

Excel Management
Reporter
Designer

Time to market Weeks Weeks Hours Hours Hours

Data sources Entity DB
OLTP

OLTP Entity DB
Azure Catalog

OLTP OLTP

Effort Days Days Minutes Hours Hours

VIEW ERVIEW ER
O P ERAT IO N A LO P ERAT IO N A L
VIEW SVIEW S

B USIN ESSB USIN ESS
DO C UM EN T SDO C UM EN T S

A N A LY T IC A LA N A LY T IC A L
TO O L S &TO O L S &
VISUA L IZ AT IO N SVISUA L IZ AT IO N S

EL EC T RO N ICEL EC T RO N IC
REP O RT IN GREP O RT IN G

F IN A N C IA LF IN A N C IA L
REP O RT IN GREP O RT IN G

Target Organization Back Office Power user Power user Finance officers

Data accuracy Near real-time Real-time Near real-time Real-time Cached views

Personalization Medium-
Modeled

None High - Free form
designer

Low -
Expressions

Medium -
Modeled

Sharing None PDF export
0365 export
Email

Dashboards
Reports
Tiles

Excel export Excel export

Printing Screen captures Local printer
Network devices

Screen captures Excel Local printer

Automation Auto-refresh Batch integration Scheduled
refresh

Batch jobs None

Scenarios Monitoring Transactions Exploratory Transactions Accounting

NOTENOTE

Operational views

Financial repor tingFinancial repor ting – Designed to provide in-depth accounting management tools based on standard

views of financial activities across legal entities.

The following table can be used as a guide when choosing the right tool for the reporting solution.

"Near real-time" denotes processed data that is slightly slower than real-time.

Operational views represent an essential part of the average employee's daily life. As important as a brush is to

a painter, operational views are used to empower people to be productive. These views contain logical

presentations of data to help the user discover patterns, highlight anomalies, and act on the most important



Analytical tools and visualizations

tasks. Targeted experiences are used to satisfy the unique information access requirements for a given persona.

These views provide actionable controls that help to maximize efficiency for common user actions. Learn more

about constructing custom operational workspaces in Build operational workspaces. Example applications of

operational views include controller operations, production floor management, and customer collections

monitoring.

What are the character istics and capabilities?What are the character istics and capabilities?

A fully-integrated experience with responsive visualizations fully-aware of user context and selections.

Views can be personalized to a large extent, to meet the unique desires of the user that are prone to change.

Actionable controls allow the user to efficiently transact and monitor activities.

Combination of analytical data to help answer general questions and transactional views to access record

details.

What distinguishes "operational views" from other types of visualizations?What distinguishes "operational views" from other types of visualizations?

General purpose tools designed to be utilized at all levels of the organization.

Pre-defined views are provided based on common information access requirements associated with a

specific role within the organization.

Highly responsive to user interactions and changes made to the transactional database.

What's impor tant to consider when selecting this tool for the job?What's impor tant to consider when selecting this tool for the job?

The platform allows users to embed Power BI tiles and links to reports directly in workspaces.

Users can introduce personalized workspaces to create their own custom operational views.

Form data sources now support aggregate queries for analytical views using native controls.

Embedded visuals based on analytical data allow users to navigate between aggregate views down to the

transactional details that affect them. Power BI service integration delivers world-class analytical tools with built-

in support for accessing data. These tools empower "citizen developers" to author the reports they need and

share the reports with others within the organization. Use the Power BI content packs available in Lifecycle

Services to get started. Learn more about Power BI integration in Features and services available through Power

BI integration. Example applications of analytical tools and visualizations include customer sales per quarter,

total revenue by region, and inventory turn-over.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/user-interface/build-workspaces
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/operational-views.png


Business documents

What are the character istics and capabilities?What are the character istics and capabilities?

Near real-time results that provide macro level insights based on micro level activities.

Common applications include charts, KPIs, and more complex visuals.

Offer a deep exploratory experience with interactive controls that provide drill-thru navigations.

What distinguishes "analytical tools and visualizations" from other types of repor ts?What distinguishes "analytical tools and visualizations" from other types of repor ts?

Highly graphical in nature, these presentations are used to find the hidden meaning behind the data.

Free form web designer that supports rich visualizations with built-in user interactions.

Utilized by power users to explore data and gain insight through analysis.

Personal in nature by allowing the user to choose which information to include.

Built-in sharing capabilities and user controlled access management.

What's impor tant to consider when selecting this tool for the job?What's impor tant to consider when selecting this tool for the job?

Developers are responsible for publishing data entities that can be consumed by Power BI.

Power users can produce mash-up views based on application data combined with external data sources.

Visuals are highly-responsive to user interactions and provide near real-time results when using Direct

Query access to the data source.

These reporting solutions are often used to capture and communicate the details of business transactions. As

such, this requires a reporting solution capable of producing physical manifestations of business data using

existing devices like network printers. Learn more about the enhancements to the Document reporting service

in Document Reporting Services. Example applications of business documents include sales invoice, customer

statements, and checks.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/supplier-quality-analysis-report.png


Electronic reporting

What are the character istics and capabilities?What are the character istics and capabilities?

Paginated documents that are ultimately destined to be printed on paper or distributed via email.

Heavily dependent on parameters to filter and produce the desired result set.

Business documents capture a snap-shot of customer and vendor activity that can be archived for future

reference.

The complex solutions are developed in Visual Studio and deployed as part of the application.

What distinguishes "business documents" from other types of visualizations?What distinguishes "business documents" from other types of visualizations?

Asynchronous data access and rendering solution designed to handle relatively large data sets.

Dedicated reporting services offer distributed resource utilization.

Ideal solution for automated processes that involve bulk generation of business documents.

Includes built-in support for document archive and data extraction via file export to PDF in addition to Word,

Excel, and CSV.

What's impor tant to consider when selecting this tool for the job?What's impor tant to consider when selecting this tool for the job?

Application suite reports are intended to be used as a starting point for custom solutions.

Solutions are heavily dependent on metadata changes and do not offer personalization.

Modifications to out-of-box solutions must be managed as a metadata change.

Electronic reporting (ER) is the tool to use to configure electronic document formats in accordance with the legal

requirements of various countries/regions. For more information about the Electronic reporting tool, see

Electronic reporting (ER) overview. Example applications of electronic reporting include financial auditing, tax

reporting, and electronic invoicing.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/image-of-business-documents.png


Financial reporting

What are the character istics and capabilities?What are the character istics and capabilities?

Perfect tool for producing TEXT, XML, and OPENXML worksheet formats.

Tooling is designed for business users familiar with Excel-based formulas.

Highly adaptable to adhere to changes in regulatory requirements.

Component versioning is available to manage draft definitions.

What distinguishes "electronic repor ts" from other types of visualizations?What distinguishes "electronic repor ts" from other types of visualizations?

Designed for electronic submission to banks, governments, and other external entities.

Use formulas to define data transformations into groups containing summary data and logical calculations.

Standard financial reports are provided using the default main account categories. Use the report designer to

create or modify traditional financial statements, such as Income statement and Balance sheet and share the

results with other members of your organization. For detailed information about the Financial reporting tooling,

see General ledger and Financial reporting overview. Example applications of financial reporting include balance

sheets, cash flow, and summary trial balance year over year.

What are the character istics and capabilities?What are the character istics and capabilities?

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/electronic-reporting-example.png
https://docs.microsoft.com/en-us/dynamics365/finance/general-ledger/general-ledger
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/financial-reporting-example.png


NOTENOTE

Built-in flexible financial reporting solution designed to handle complex organizational structures.

Fully-integrated with General ledger.

Create custom financial reports using the default solutions as a starting point.

Interactive reports with drill-down capabilities to navigate down to transaction details.

What distinguishes "financial repor ts" from other types of visualizations?What distinguishes "financial repor ts" from other types of visualizations?

User controls are tailored for the specialized needs of financial reporting.

Create roll-up reports containing data across companies or business units.

Utilizes a financial data mart for optimized performance.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Data exploration through Power BI

Ready-made Power BI content

Microsoft Power BI is a suite of business analytics tools that let you analyze data and share insights. By using

Power BI tools, you can explore data and quickly create rich reports and dashboards. You and your colleagues

can then use the reports interactively on many devices. The application uses Power BI for data exploration.

There are various types of reporting.

Chart controls are used to build embedded experiences that require visuals.

Microsoft SQL Server Reporting Services (SSRS) is an engine that is designed for pixel-perfect, formatted

reports that often require printing. We use SSRS for document-style reports, such as invoices and purchase

orders. Our investments in SSRS integration focus on document generation and printing scenarios.

For all non-document reports or reports that don’t have to be printed, we want to embrace Power BI.

In the past, we have used the terms self-service reports and ad-hoc reports to refer to Power BI. We will now use

the term data exploration. This change in terminology reflects a subtle shift in paradigms. Self-service reports

were reports that the users themselves created. (Alternatively, a power user created the reports and shared

them with other people. These people then continued to adjust the reports according to their requirements.)

Often, users had to change the shape of a chart, add a new column, change the grouping, or just create a new

view of data. Although we might think of the results as reports, users are just trying to understand the data by

exploring it, pivoting it around columns, and changing the shape of charts. Technologies of the past didn’t let

users interactively explore large volumes of data. Therefore, users had to create "reports," or many views of the

same data.

In Power BI, thanks to the in-memory database technologies in Microsoft SQL Server, a report is a just the

starting point for interactive data exploration. Charts in a Power BI report invite users to click them, visuals

change shape interactively, and data can easily be filtered. Users can easily adjust existing reports and create

their own views of the data. The reports can be shared, and teams can collaborate over data.

Therefore, although you might use the term report to refer to Power BI artifacts, you should think about the

larger scenario that is involved. Your users are exploring data! Power BI is the tool of choice when you must

address data exploration and visualization requirements.

For a detailed discussion of reporting concepts, see Information access and reporting.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/power-bi-integration.md


Power BI content that is available in LCSPower BI content that is available in LCS

Power BI content packs that are distributed in the PowerBI.com marketplacePower BI content packs that are distributed in the PowerBI.com marketplace

Extending, creating, and distributing Power BI reports

Creating high-volume, near-real-time "operational Power BI reports" by using Entity storeCreating high-volume, near-real-time "operational Power BI reports" by using Entity store

Creating Power BI reports by using ExcelCreating Power BI reports by using Excel

You can use ready-made Power BI reports right away. Two types of Power BI content are available:

Power BI content that is available in Microsoft Dynamics Lifecycle Service (LCS)

Power BI content packs that are distributed in the PowerBI.com marketplace

Depending on your version, you can use one of both types of content.

LCS is a service that can manage your environments. LCS is operated by Microsoft. Power BI reports are

developed by using Entity store and are then distributed in LCS as implementation assets. In LCS, you will find

not only content that is developed by Microsoft, but also content that is developed by independent software

vendors (ISVs) and partners.

We will continue to release Power BI content that is based on Entity store. For information, see the Roadmap.

There are several Power BI content packs in the PowerBI.com marketplace. Although these content packs will

continue to be supported until further notice, our future investments in content packs will be based on Entity

store, and content will be released via LCS.

For more information about the content, see Power BI content.

You should use the ready-made Power BI content as a first step. You can modify ready-made reports or extend

them by using capabilities that are built into PowerBI.com. In addition to modifying ready-made reports, you can

extend them using Power BI authoring tools such as Power BI desktop. You can also create new reports. You can

use several approaches to create new Power BI reports.

Entity store is an operational data store that is built specifically for Power BI integration. To create high-volume,

near-real-time Power BI reports that use Entity store, a business analyst or a developer can use Power BI

desktop, which is the authoring tool for Power BI reports. Like other artifacts that developers create, these

reports must be distributed to your users via LCS.

Reports that are created by using Entity store take advantage of DirectQuery technology. This technology

enables reports to be created over large volumes of data. Reports that are created by using DirectQuery

technology don't cache data in the PowerBI.com service. Instead, data is always stored in application.

For an overview of Power BI integration with Entity store, see Power BI integration with Entity store.

If you're upgrading from Microsoft Dynamics AX 2012, you can upgrade cubes to aggregate measurements that

use Entity store. You can then create Power BI reports by using Entity store. For more information, see Migrate

upgraded AX 2012 R3 sales cubes to the entity store.

In addition to using the Power BI desktop authoring tool, you can use "Power tools" that are incorporated into

Excel to create visualizations. Your organization might have many users who already use Excel every day. For a

quick "one-off" report, Excel might be the best option for these users.

There are several scenarios where you can use Excel:

Export data from a page in Dynamics 365 into Excel. You can then use the Power View add-in that is built into

Excel to visualize the data. The Excel workbook can be used as a stand-alone visualization. In addition, you

can import the report into the PowerBI.com service.

Use the Power Query extension in Excel to combine the data in another worksheet (or data that is imported

from OData endpoints) with external data. You can visualize the resulting data by using Power View.

https://roadmap.dynamics.com
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/migration-upgrade/migrate-upgraded-cube-entity-store


Sharing and using reports in PowerBI.com

Pinning Power BI content to the client

One-time configuration of PowerBI.com integrationOne-time configuration of PowerBI.com integration

Pinning PowerBI.com tilesPinning PowerBI.com tiles

Pinning PowerBI.com reports to workspacesPinning PowerBI.com reports to workspaces

NOTENOTE

Use the PowerPivot extension in Excel to ingest a larger amount of data into Excel.

Consider using Export to Excel functionality for ad-hoc "one-off" reports. If the reports will be shared with a

group of users, you should consider using Entity store to create them.

PowerBI.com is a service that is offered by Microsoft. It lets you create dashboards and reports, and also enables

collaboration with a group of users. Regardless of how you create your reports, you can share reports with

users by uploading them into the PowerBI.com service. (This process is also known as publishing.)

After your reports are uploaded, your users can view, adjust, and explore them either on the web (when they are

connected to the Internet at home or in the office) or by using apps on a device.

For more information about Power BI concepts, see the Power BI documentation.

PowerBI.com can be used on its own as a reporting and dashboard solution for your organization or business

unit. However, users can also pin tiles and reports from their own PowerBI.com accounts to workspaces. Power

BI content in Dynamics 365 provides contextual insights that are related to business operations.

You can pin two types of objects from PowerBI.com: tiles in PowerBI.com dashboards, and reports.

Before you can pin Power BI content, you must configure Power BI in your Dynamics 365 environment.

Before you can pin tiles or reports, an administrator must configure integration with PowerBI.com in your

environment. This configuration must be done only one time per environment. For instructions, see Configure

Power BI integration for workspaces.

Power BI tiles that are pinned to the Dynamics 365 client provide insightful visuals at a glance. They also let

users open PowerBI.com for interactive analysis. For more information, see Configure Power BI integration for

workspaces.

As a power user, a business analyst, or a developer, you can use Power BI desktop to create reports that use

Entity store. Not only are these reports rich and interactive, but your users can make changes without having to

rely on another person.

Although the reports in PowerBI.com are powerful and interactive on their own, they can also be pinned into

workspaces. Your users can pin reports to workspaces themselves. For more information about how to pin

reports to workspaces, see Pin Power BI reports to workspaces.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://powerbi.microsoft.com/documentation/powerbi-service-how-should-i-share-my-dashboard/
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Pin Power BI content
2/18/2021 • 3 minutes to read • Edit Online

Pin Power BI reports to workspaces

Microsoft Dynamics 365 Finance uses Power BI for data exploration. This topic explains how you can pin full-

page Power BI reports to workspaces to give your users an interactive data exploration experience.

This topic assumes that you're familiar with the feature that lets you pin Microsoft Power BI tiles to a workspace.

For more information, see Features and services available through Power BI integration. If you're a developer

who is creating a workspace, to let users pin Power BI tiles to the workspace, embed the Power BI tile control.

Microsoft Dynamics AX platform update 1 (May 2016) introduced the capability to pin Power BI reports to

workspaces. Power BI reports can be added to any workspace that contains a L inksLinks  section. In other words, the

reports can be added to most of the out-of-box workspaces that are included in the product. To enable Power BI

reports and tiles, you must configure Power BI to work with the application. This one-time operation must be

completed by an administrator of the environment. For instructions, see Configure Power BI integration for

workspaces. After you've configured Power BI to work with the application, open the Ledger budgets andLedger budgets and

forecastsforecasts  workspace in the client. In the workspace, click the OptionsOptions  tab. Notice that this tab contains buttons

to open the (Power BI) tile catalog and the (Power BI) report catalog. Click Open repor t catalogOpen repor t catalog. A dialog box

that contains a list of reports appears. The list of reports comes from the reports that you have in your Power BI

account. If you open PowerBI.com in a browser, you will see that the same list of reports is used across your

Power BI dashboards. Select some reports, as shown in the following illustration, and then click OKOK to continue.

Next, scroll to the bottom of the L inksLinks  section in the workspace. Notice that a new section for Power BI reports

has been added to your links.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/pin-power-bi-reports.md
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ledger-budgets-workspace-list-of-reports-chosen.jpg


Full-page Power BI reports in the client
You can open and run Power BI reports in the client. The functionality resembles the functionality for running

Microsoft SQL Server Reporting Services (SSRS) reports. To run a Power BI report, in the L inksLinks  section, click the

link for one of the Power BI reports. For this example, click the Retail Analysis SampleRetail Analysis Sample link. The Power BI

report is opened in the client in a full-page view, as shown in the following illustration. This report is interactive.

As you click regions of the report, the remaining visuals react to your selection.

You can filter the data on the report by using the filter pane. The following illustration shows the report after

filters have been applied.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ledger-budgets-workspace-reports-in-links-section.jpg
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/retail-analysis-report-full-page-no-filters.jpg


Power BI in user-created workspaces

You can also open this report on PowerBI.com and make changes. You can then save the modified report as

another copy that has a different name, and even pin the new report to the workspace.

So far, we have described how to add Power BI tiles and reports to "developer-created" workspaces. Developer-

created workspaces are workspaces that are created by Microsoft (that is, they are built into the product), by

your independent software vendor (ISV) or partner, or by in-house developers. However, in Microsoft Dynamics

AX platform update 1 (May 2016), users can create new workspaces by using the personalization capabilities of

the client. To create a new workspace, on the home page (or the dashboard), right-click the tile for a workspace,

and then click Add a workspaceAdd a workspace. A new workspace is created. New workspaces are named My Workspace 1My Workspace 1 ,

My Workspace 2My Workspace 2 , and so on. You can change the name later. Click the workspace that you just created. You can

now add Power BI tiles and reports by using the same options that we discussed earlier. The following

illustration shows an example.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/retail-analysis-report-full-page-filtered-view-1.jpg
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/my-workspace-with-tiles-and-reports.jpg
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Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Analytical workspaces

IMPORTANTIMPORTANT

Motivations for embedding PowerBI.com reportsMotivations for embedding PowerBI.com reports

Embed a PowerBI.com report in an analytical workspaceEmbed a PowerBI.com report in an analytical workspace

The analytical workspaces that are bundled with the application suite offer users relevant insights into their

business data. However, in some cases, it might make sense to replace standard reports with custom reports

that are designed specifically for the users in your organization.

The world-class tooling that PowerBI.com provides lets you produce analytical reports that contain mashup

views that use data from external sources. In Platform update 26 for Finance and Operations, power users can

replace the standard embedded reports with those that are hosted on PowerBI.com.

The functionality that this topic describes isn't a personalization. The customization of analytical workspaces applies to all

users in the active legal entity.

Although standard reports deliver insights that are tailored for a given business persona, an organization might

prefer a custom report in some cases. The application lets power users promote custom reports that are hosted

on PowerBI.com and shared with members of the organization.

Here are some of the top motivations for selecting reports that are hosted on PowerBI.com:

PowerBI.com reports support data mashups that use external data sources and can be accessed outside the

application.

The reports are appropriate for demonstrating custom solutions that are hosted on PowerBI.com and

embedded in the application in one-box deployments.

Organizations that have Microsoft Power BI Premium services want to augment the standard reports.

The How to embed PowerBI.com reports video (shown above) is included in the Finance and Operations playlist

available on YouTube.

To replace the standard reports, you must be a member of the System Report Editors security group. Members

of this security group can access the options in application workspaces that let them customize the standard

reports. This example shows how to replace the standard analytical report with a customized report that is

hosted on PowerBI.com.

1. Sign in and open the application report that you want to customize. In this example, you will replace the

standard analytical report that is embedded in the Compensation managementCompensation management workspace.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/select-analytical-workspace.md
https://www.microsoft.com/videoplayer/embed/RE3lP5m
https://www.youtube.com/watch?v=gGWuNJDoi-M&feature=youtu.be
https://www.youtube.com/playlist?list=PLcakwueIHoT_SYfIaPGoOhloFoCXiUSyW


NOTENOTE

2. Select the AnalyticsAnalytics  tab to access the workspace's embedded analytical report.

By default, you will see the standard analytical workspace solution that is included with your application.

The reports in this solution are automatically deployed and configured for your environment during the

provisioning process.

The analytical workspaces require a hosted Power BI service that is available only for dedicated environments. For

more information, see the blog post, Accessing Analytical Workspaces and Reports on 1-Box Environments.

3. On the Action Pane, on the OptionsOptions  tab, in the Power BIPower BI group, select Select AnalyticsSelect Analytics  to open the

Power BI Repor tsPower BI Repor ts  dialog box.

https://blogs.msdn.microsoft.com/dynamicsaxbi/2017/07/29/accessing-analytical-workspaces-on-1box-environment/


Revert to the standard solutionRevert to the standard solution

This dialog box lets you select among the reports that have been shared on the PowerBI.com service. The

reports are organized by workspace.

4. In the drop-down list, select the workspace that contains the report.

5. Select the report to embed in the application workspace, and then select OKOK.

6. To view the updates to the workspace, you must reload the page. Either move away from the workspace

and then return, or refresh your browser.

7. In the Compensation managementCompensation management workspace, select the AnalyticsAnalytics  tab to access the PowerBI.com

report that is now embedded in the analytical workspace.

After a PowerBI.com report has been embedded in an application workspace, updates to the report are reflected

immediately for users. However, to replace the report with another PowerBI.com solution, a power user must

first revert to the standard application solution. Follow these steps to revert to the standard application solution.

1. On the Action Pane, on the OptionsOptions  tab, in the Power BIPower BI group, select Restore AnalyticsRestore Analytics .



NOTENOTE

2. To view the updates to the workspace, you must reload the page. Either move away from the workspace

and then return, or refresh your browser.

3. In the Compensation managementCompensation management workspace, select the AnalyticsAnalytics  tab to access the standard

solution that is now embedded in the analytical workspace.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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PowerBI.com solutions available from Lifecycle Services (LCS)

NOTENOTE

PowerBI.com solutions available from AppSource

NOTENOTE

The following PowerBI.com solutions are available for application environments.

The following PowerBI.com solutions are available in the Shared assets library of LCS. Refer to the version

information in the Shared assets library to download the correct version for your environment.

Most of the PowerBI.com solutions in the following list have been embedded in analytical workspaces in recent versions.

Using analytical workspaces eliminates the need to download these solutions from the Shared assets library in LCS. The

topics in this list indicate where these PowerBI.com solutions have been embedded where applicable.

Actual vs budget

Cash overview

Compensation and benefits

Cost accounting analysis

Credit and collections management

Employee competencies and development

Financial performance

Fixed asset management

Organizational training

Practice manager

Production performance

Purchase spend analysis

Recruiting

Sales and profitability performance

Vendor payments

Warehouse performance

Workforce metrics

The following PowerBI.com solutions are available from Microsoft AppSource.

These solutions have been deprecated as documented in Power BI content packs available on AppSource.

Cost management

Financial performance

Retail channel performance

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/power-bi-home-page.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/ledger-budgets-power-bi
https://docs.microsoft.com/en-us/dynamics365/finance/cash-bank-management/cash-overview-power-bi-content
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/compensation-and-benefits-analysis-power-bi-content-pack
https://docs.microsoft.com/en-us/dynamics365/finance/accounts-receivable/credit-collections-power-bi
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/employee-competencies-and-development-analysis-power-bi-content-pack
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/financial-performance-power-bi-content-pack
https://docs.microsoft.com/en-us/dynamics365/finance/fixed-assets/fixed-asset-management-workspace
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/practice-manager-power-bi
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/purchase-content-pack-for-power-bi
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/recruiting-analysis-power-bi-content-pack
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/sales-profitability-performance-content-pack
https://docs.microsoft.com/en-us/dynamics365/finance/accounts-payable/vendor-payments-workspace
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/workforce-analysis-power-bi-content-pack
https://appsource.microsoft.com
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/financial-performance-power-bi-content-pack
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/retail-channel-performance-dashboard-power-bi-data
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Overview

NOTENOTE

Accessing the Power BI content

Report pages that are included in the Power BI content

The Cost managementCost management Microsoft Power BI content is intended for inventory accountants or individuals in the

organization who are responsible for or interested in the status of inventory or work in progress (WIP), or who

are responsible for or interested in analyzing standard cost variances.

The Cost managementCost management  Power BI content described in this this topic applies to Dynamics 365 Finance and Operations

8.0.

The Cost managementCost management  Power BI content pack, available on the AppSource site, has been deprecated. For more

information about that deprecation, see Removed or deprecated features for Finance and Operations.

This Power BI content provides a categorized format that helps you monitor the performance of inventories and

visualize how cost flows through them. You can gain managerial insights such as the turnover ratio, number of

days that inventory is on hand, accuracy, and "ABC classification" at your preferred aggregated level (company,

item, item group, or site). The information that is made available can also be used as a detailed supplement to

the financial statement.

The Power BI content is built on the CostObjectStatementCacheMonthlyCostObjectStatementCacheMonthly  aggregated measurement, which

has the CostObjectStatementCacheCostObjectStatementCache table as its primary data source. This table is managed by the Data set

cache framework. By default, the table is updated every 24 hours, but you can change the update frequency or

enable manual updates in the configuration of the data set cache. Manual updates can be run in either the CostCost

administrationadministration workspace or the Cost analysisCost analysis  workspace.

After every update of the CostObjectStatementCacheCostObjectStatementCache table, the CostObjectStatementCacheMonthlyCostObjectStatementCacheMonthly

aggregated measurement must updated before data in the Power BI visualizations is updated.

The Cost managementCost management Power BI content is shown in the Cost administrationCost administration and Cost analysisCost analysis

workspaces.

The Cost administrationCost administration workspace contains the following tabs:

Over viewOver view  – This tab shows application data.

Inventor y accounting statusInventor y accounting status  – This tab shows Power BI content.

Manufactur ing accounting statusManufactur ing accounting status  – This tab shows Power BI content.

The Cost analysisCost analysis  workspace contains the following tabs:

Over viewOver view  – This tab shows application data.

Inventor y accounting analysisInventor y accounting analysis  – This tab shows Power BI content.

Manufactur ing accounting analysisManufactur ing accounting analysis  – This tab shows Power BI content.

Std. cost var iance analysisStd. cost var iance analysis  – This tab shows Power BI content.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/cost-management-content-pack.md


Inventory accounting statusInventory accounting status

REP O RT  PA GEREP O RT  PA GE VISUA L IZ AT IO NVISUA L IZ AT IO N

Inventory overview Beginning balance

Net change

Net change %

Ending balance

Inventory accuracy

Inventory turnover ratio

Days inventory on-hand

Active product in period

Active cost objects in period

Balance by item group

Balance by site

Statement by category

Net change by quarter

Inventory overview by site and item group Inventory accuracy by site

Inventory turnover ratio by site

Inventory ending balance by site

Inventory accuracy by item group

Inventory turnover ratio by item group

Inventory ending balance by site and item group

Inventory statement Inventory statement

Inventory statement by site Inventory statement by site

Inventory statement by product hierarchy Inventory statement

Inventory statement by product hierarchy Inventory statement by site

The Cost managementCost management Power BI content includes a set of report pages that consist of a set of metrics. These

metrics are visualized as charts, tiles, and tables.

The following tables provide an overview of the visualizations in the Cost managementCost management Power BI content.



REP O RT  PA GEREP O RT  PA GE VISUA L IZ AT IO NVISUA L IZ AT IO N

Manufacturing accounting statusManufacturing accounting status

REP O RT  PA GEREP O RT  PA GE VISUA L IZ AT IO NVISUA L IZ AT IO N

WIP overview YTD Beginning balance

Net change

Net change %

Ending balance

WIP turnover ratio

Days WIP on-hand

Active cost object in period

Net change by resource group

Balance by site

Statement by category

Net change by quarter

WIP statement Beginning balance

Ending balance

WIP statement by category

WIP statement by site Beginning balance

Ending balance

WIP statement by category and site

WIP statement by hierarchy Beginning balance

Ending balance

WIP statement by category hierarchy

Inventory accounting analysisInventory accounting analysis

REP O RT  PA GEREP O RT  PA GE VISUA L IZ AT IO NVISUA L IZ AT IO N

Inventory details Top 10 resources by ending balance



Top 10 resources by net change increase

Top 10 resources by net change decrease

Top 10 resources by inventory turnover ratio

Resources by low inventory turnover ratio and ending
balance above threshold

Top 10 resources by low accuracy

ABC classification Inventory ending balance

Consumed material

Sold (COGS)

Inventory trends Inventory ending balance

Inventory net change

Inventory turnover ratio

Inventory accuracy

REP O RT  PA GEREP O RT  PA GE VISUA L IZ AT IO NVISUA L IZ AT IO N

Manufacturing accounting analysisManufacturing accounting analysis

REP O RT  PA GEREP O RT  PA GE VISUA L IZ AT IO NVISUA L IZ AT IO N

WIP trends WIP ending balance

WIP net change

WIP turnover ratio

Std. cost variance analysisStd. cost variance analysis

REP O RT  PA GEREP O RT  PA GE VISUA L IZ AT IO NVISUA L IZ AT IO N

Purchase price variance (Std. cost) YTD Procured balance

Purchase price variance

Purchase price variance ratio

Variance by item group

Variance by site

Purchase price by quarter



Purchase price by quarter and Item group

Top 10 resources by unfavorable purchase price ratio

Top 10 resources by favorable purchase price ratio

Production variance (Std. cost) YTD Manufactured cost

Production variance

Production variance ratio

Variance by item group

Variance by site

Production variance by quarter

Production variance by quarter and variance type

Top 10 resources by unfavorable production variance

Top 10 resources by favorable production variance

REP O RT  PA GEREP O RT  PA GE VISUA L IZ AT IO NVISUA L IZ AT IO N

Understanding the data model and entities

O B JEC TO B JEC T
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DATA  SO URC E F O RDATA  SO URC E F O R
F IN A N C E A N D O P ERAT IO N SF IN A N C E A N D O P ERAT IO N S F IEL DF IEL D

CostObjectStatementCache
Monthly

Amount CostObjectStatementCache Amount

CostObjectStatementCache
Monthly

Quantity CostObjectStatementCache Qty

CostInventoryAccountingKP
IGoal

AnnualInventoryTurn CostInventoryAccountingKP
IGoal

AnnualInventoryTurn

CostInventoryAccountingKP
IGoal

InventoryAccuracy CostInventoryAccountingKP
IGoal

InventoryAccuracy

Data from the application is used to fill the report pages in the Cost managementCost management Power BI content. This data

is represented as aggregate measurements that are staged in the entity store, which is a Microsoft SQL Server

database that is optimized for analytics. For more information, see Power BI integration with Entity store.

The key aggregate measurements of the following objects are used as the basis of the Power BI content.

The following table shows the key calculated measurements in the Power BI content.



M EA SUREM EA SURE C A L C UL AT IO NC A L C UL AT IO N

Beginning balance Beginning balance = [Ending balance]-[Net change]

Beginning balance qty. Beginning balance qty. = [Ending balance qty.]-[Net change
qty.]

Ending balance Ending balance = (CALCULATE(SUM([Amount]),
FILTER(ALL(FiscalCalendar)
,FiscalCalendar[MONTHSTARTDATE] <=
MAX(FiscalCalendar[MONTHSTARTDATE]))))

Ending balance qty. Ending balance qty. = CALCULATE(SUM([QTY]),
FILTER(ALL(FiscalCalendar),FiscalCalendar[MONTHSTARTDAT
E] <= MAX(FiscalCalendar[MONTHSTARTDATE])))

Net change Net change = SUM([AMOUNT])

Net change qty. Net change qty. = SUM([QTY])

Inventory turnover ratio by amount Inventory turnover ratio by amount = if(OR([Inventory
average balance] <= 0, [Inventory sold or consumed issues]
>= 0), 0, ABS([Inventory sold or consumed
issues])/[Inventory average balance])

Inventory average balance Inventory average balance = (([Ending balance] + [Beginning
balance]) / 2)

Days inventory on-hand Days inventory onhand = 365 /
CostObjectStatementEntries[Inventory turnover ratio by
amount]

Inventory accuracy Inventory accuracy by amount = IF([Ending balance] <= 0,
IF(OR([Inventory counted amount] <> 0, [Ending balance] <
0), 0, 1), MAX(0, ([Ending balance] - ABS([Inventory counted
amount]))/[Ending balance]))

EN T IT YEN T IT Y EXA M P L ES O F  AT T RIB UT ESEXA M P L ES O F  AT T RIB UT ES

Products Product number, Product name, Unit, Item groups

Category hierarchies (Assigned to role Cost management) Category hierarchy, Category level

Legal entities Legal entity names

Fiscal calendars Fiscal calendar, Year, Quarter, Period, Month

Site ID, Name, Address, State, Country

The following key dimensions are used as filters to slice the aggregate measurements, so that you can achieve

greater granularity and gain deeper analytical insights.
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Reports that are included in the Power BI content

REP O RTREP O RT C O N T EN T SC O N T EN T S

Learning Overview Summary of other reports

Course Analysis Registration by location, attendee by status, courses by type
per company, and course attendance by job 

Registration Analysis Registration list

Course Types Course types by skill

Instructor Analysis Ratio of courses to instructors, number of instructors,
courses by instructor, courses per instructor, and course
agenda by instructor

Courses Offered List of courses

Courses Design Course agenda

Understanding the data model and entities

EN T IT YEN T IT Y C O N T EN T SC O N T EN T S
REL AT IO N SH IP S W IT H  OT H ERREL AT IO N SH IP S W IT H  OT H ER
EN T IT IESEN T IT IES

Calendar Offset Calendar offsets to slice reports Course Agenda, Course Attendees

Company Companies to filter reports by Course Agenda, Course Attendees

Course Course, description, instructor name,
location, room, and status

Course Agenda, Course Attendees,
Course Skill

Course Agenda Agenda, course, and start and end
times

Company, Calendar Offset, Date,
Course

This topic describes the LearningLearning Microsoft Power BI content.

The reports that are included in the LearningLearning Power BI content have both charts and tables that contain

additional information. The following table describes the reports.

You can filter the charts and tiles on these reports, and pin the charts and tiles to the dashboard. For more

information about how to filter and pin in Power BI, see Create and Configure A Dashboard.

The following data is used to fill the reports in the LearningLearning Power BI content. This table shows the entities that

the content was based on.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/learning-power-bi.md
https://powerbi.microsoft.com/guided-learning/powerbi-learning-4-2-create-configure-dashboards


Course Attendees Name, status, job, and registration
date

Company, Calendar Offset, Date,
Course, Demographics, Employment,
Course, Employee Name, Employee
Title, Job, Position

Course Skill Skill, skill type, and level Course

Date Days, weeks, months, and years Course Agenda, Course Attendees

Demographics Date of birth, gender, ethnic origin,
and marital status

Course Agenda, Course Attendees

Employment Start date, end date, and transition
date

Course Agenda, Course Attendees

Job Function, type, and title Course Agenda, Course Attendees

Position Position, title, and full-time equivalent
(FTE)

Course Agenda, Course Attendees

Employee Name First name, last name, and full name Course Attendees

Employee Title Title and seniority date Course Attendees

EN T IT YEN T IT Y C O N T EN T SC O N T EN T S
REL AT IO N SH IP S W IT H  OT H ERREL AT IO N SH IP S W IT H  OT H ER
EN T IT IESEN T IT IES
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Reports that are included in the content pack

REP O RTREP O RT C O N T EN T SC O N T EN T S

Course Analysis Registration by location, course attendees by status, and
registration list

Course Types Course types by skill

Understanding the data model and entities

EN T IT YEN T IT Y C O N T EN T SC O N T EN T S
REL AT IO N SH IP S W IT H  OT H ERREL AT IO N SH IP S W IT H  OT H ER
EN T IT IESEN T IT IES

Training_CalendarOffset Calendar offsets to slice reports Training_CourseAgenda,
Training_CourseAttendees

Training_Company Companies to filter reports by Training_CourseAgenda,
Training_CourseAttendees

Training_Course Course, description, instructor name,
location, room, and status

Training_CourseAgenda,
Training_CourseAttendees,
Training_CourseSkill

Training_CourseAgenda Agenda, course, and start and end
times

Training_Company,
Training_CalendarOffset, Training_Date,
Training_Course

Training_CourseAttendees Name, status, job, and registration
date

Training_Company,
Training_CalendarOffset, Training_Date,
Training_Demographics,
Training_Employment, Training_Course,
Training_WorkerName,
Training_WorkerTitle, Training_Job,
Training_Position

This topic describes the Finance and Operations - Organizational training Power BI content.

After you've connected the content pack to your data, the reports show your organization's data. If you've never

used Microsoft Power BI before, you can learn more about it on the Guided Learning page for Power BI. The

reports that are included in the content pack have both charts and tables that contain additional information.

The following table describes the reports.

You can filter the charts and tiles on these reports, and pin the charts and tiles to the dashboard. For more

information about how to filter and pin in Power BI, see Create and Configure A Dashboard.

Application data is used to populate the reports in the Organizational training content pack. The following table

shows the entities that the content pack was based on.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/organizational-training-analysis-power-bi-content-pack.md
https://powerbi.microsoft.com/guided-learning/?WT.mc_id=PBIService_GetData
https://powerbi.microsoft.com/guided-learning/powerbi-learning-4-2-create-configure-dashboards


Training_CourseSkill Skill, skill type, and level Training_Course

Training_Date Days, weeks, months, and years Training_CourseAgenda,
Training_CourseAttendees

Training_Demographics Date of birth, gender, ethnic origin,
and marital status

Training_CourseAgenda,
Training_CourseAttendees

Training_Employment Start date, end date, and transition
date

Training_CourseAgenda,
Training_CourseAttendees

Training_Job Function, type, and title Training_CourseAgenda,
Training_CourseAttendees

Training_Position Position, title, and full-time equivalent
(FTE)

Training_CourseAgenda,
Training_CourseAttendees

Training_WorkerName First name, last name, and full name Training_CourseAttendees

Training_WorkerTitle Title and seniority date Training_CourseAttendees

EN T IT YEN T IT Y C O N T EN T SC O N T EN T S
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Overview

Accessing the Power BI content

Metrics that are included in the Power BI content

REP O RT  PA GEREP O RT  PA GE C H A RT SC H A RT S T IL EST IL ES

Production performance

This topic describes what is included in the Production performanceProduction performance Microsoft Power BI content. It explains

how to access the Power BI reports, and provides information about the data model and entities that were used

to build the content.

The Production performanceProduction performance Power BI content is for production managers or individuals in the organization

who are responsible for production control.

The reports that are included let you use Power BI to monitor the performance of manufacturing operations

with regard to timely execution, quality, and cost. The reports use transactional data from production orders and

batch orders, and provide both an aggregate view of company-wide production metrics and a breakdown of

metrics by product and resource.

The Power BI content highlights the organization's ability to complete production on time and in full. Future

performance is projected based on the production plans. Comprehensive reports provide detailed insights into

product defects that are caused by production, and also the defect rates for resources and operations.

This Power BI content also lets you analyze production variances. Production variances are calculated as the

difference between estimated cost and realized cost. Production variances are calculated when production

orders or batch orders reach EndedEnded status.

The Production performanceProduction performance Power BI content includes data that originates from production orders and

batch orders. The reports don't include data that is related to kanban productions.

The Production performanceProduction performance Power BI content is shown on the Production performanceProduction performance page

(Production controlProduction control  > Inquir ies and repor tsInquir ies and repor ts  > Production performance analysisProduction performance analysis  > ProductionProduction

performanceperformance).

The Production performanceProduction performance Power BI content includes a set of report pages. Each page consists of a set of

metrics that are visualized as charts, tiles, and tables.

The following table provides an overview of the visualizations that are included.

Number of production by date

Number of productions by
product and item group

Number of planned
productions by date

Bottom 10 products by on-
time & in-full

Total orders

On-time & in full %

Incomplete %

Early %

Late %

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/production-performance-power-bi.md


Defects by product

Defects trend by product Defect rate (ppm) by quantity
produced

Defect rate (ppm)

Defects by resource Defective quantity

Defects trend by resource Defect rate (ppm) by quantity
processed

Production variances for job order
costing

REP O RT  PA GEREP O RT  PA GE C H A RT SC H A RT S T IL EST IL ES

Understanding the data model and entities
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CostCalculation CostAmount ProdCalcTransExpanded CostAmount

CostCalculation CostMarkup ProdCalcTransExpanded CostMarkup

CostCalculation ActualCostAmount ProdCalcTransExpanded RealCostAmount

CostCalculation RealCostAdjustment ProdCalcTransExpanded RealCostAdjustment

RouteTransactions ErrorQuantity ProdRouteTransExpanded QtyError

Defective rate (ppm) by date

Defective rate (ppm) by
product and item group

Quantity produced by date

Top 10 products by effective
rate

Defective rate (ppm)

Defective quantity

Total quantity

Defect rate (ppm) by date

Defect rate (ppm) by resource
and Site

Defect rate (ppm) by operation

Top 10 resources by defect rate

Production variance by date
and cost group type

Production variance by site and
cost group type

Top 10 products with
unfavorable production
variance

Top 10 unfavorable production
variance by resource

Realized cost

Production variance

Production variance %

The following data is used for the report pages in the Production performanceProduction performance Power BI content. This data is

represented as aggregate measurements that are staged in the Entity store. The Entity store is a Microsoft SQL

Server database that is optimized for analytics. To learn more about the entity store, see Power BI integration

with Entity store.

The following table shows the key aggregate measurements that are used as the basis of the Power BI content.



RouteTransactions GoodQuantity ProdRouteTransExpanded QtyGood

ProductionOrder DaysDelayed ProdTableExpanded DaysDelayed

ProductionOrder LeadTime ProdTableExpanded LeadTime

ProductionOrder PlannedLeadTime ProdTableExpanded PlannedLeadTime

ProductionOrder ProductionOrderCount ProdTableExpanded

CoproductCostCalculation CoproductCostAmount PmfCoByProdCalcTransExpa
nded

CostAmount

CoproductCostCalculation CoproductCostMarkup PmfCoByProdCalcTransExpa
nded

CostMarkup

CoproductCostCalculation CoproductRealCostAdjustm
ent

PmfCoByProdCalcTransExpa
nded

RealCostAdjustment

CoproductCostCalculation CoproductActualCostAmou
nt

PmfCoByProdCalcTransExpa
nded

RealCostAmount

EN T IT YEN T IT Y
KEY  A GGREGAT EKEY  A GGREGAT E
M EA SUREM EN T SM EA SUREM EN T S

DATA  SO URC E F O RDATA  SO URC E F O R
F IN A N C E A N D O P ERAT IO N SF IN A N C E A N D O P ERAT IO N S
A P P SA P P S F IEL DF IEL D
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Production variance, % SUM('Production variance'[Production variance]) /
SUM('Production variance'[Estimated cost])

All planned orders COUNTROWS('Planned production order')

Early COUNTROWS(FILTER('Planned production order', 'Planned
production order'[Scheduled end date] < 'Planned
production order'[Requirement date]))

Late COUNTROWS(FILTER('Planned production order', 'Planned
production order'[Scheduled end date] > 'Planned
production order'[Requirement date]))

On-time COUNTROWS(FILTER('Planned production order', 'Planned
production order'[Scheduled end date] = 'Planned
production order'[Requirement date]))

On-time % IF ( 'Planned production order'[On-time] <> 0, 'Planned
production order'[On-time], IF ('Planned production
order'[All planned orders] <> 0, 0, BLANK()) ) / 'Planned
production order'[All planned orders]

Completed COUNTROWS(FILTER('Production order', 'Production
order'[Is RAF'ed] = TRUE))

The following table shows how the key aggregate measurements are used to create several calculated measures

in the content's dataset.



Defective rate (ppm) IF( 'Production order'[Total quantity] = 0, BLANK(),
(SUM('Production order'[Defective quantity]) / 'Production
order'[Total quantity]) * 1000000)

Delayed production rate 'Production order'[Late #] / 'Production order'[Completed]

Early & in full COUNTROWS(FILTER('Production order', 'Production
order'[Is in full] = TRUE && 'Production order'[Is early] =
TRUE))

Early # COUNTROWS(FILTER('Production order', 'Production
order'[Is early] = TRUE))

Early % IFERROR( IF('Production order'[Early #] <> 0, 'Production
order'[Early #], IF('Production order'[Total orders] = 0,
BLANK(), 0)) / 'Production order'[Total orders], BLANK())

Incomplete COUNTROWS(FILTER('Production order', 'Production
order'[Is in full] = FALSE && 'Production order'[Is RAF'ed] =
TRUE))

Incomplete % IFERROR( IF('Production order'[Incomplete] <> 0,
'Production order'[Incomplete], IF('Production order'[Total
orders] = 0, BLANK(), 0)) / 'Production order'[Total orders],
BLANK())

Is delayed 'Production order'[Is RAF'ed] = TRUE && 'Production
order'[Delayed value] = 1

Is early 'Production order'[Is RAF'ed] = TRUE && 'Production
order'[Days delayed] < 0

Is in full 'Production order'[Good quantity] >= 'Production
order'[Scheduled quantity]

Is RAF'ed 'Production order'[Production status value] = 5 || 'Production
order'[Production status value] = 7

Late & in full COUNTROWS(FILTER('Production order', 'Production
order'[Is in full] = TRUE && 'Production order'[Is delayed] =
TRUE))

Late # COUNTROWS(FILTER('Production order', 'Production
order'[Is delayed] = TRUE))

Late % IFERROR( IF('Production order'[Late #] <> 0, 'Production
order'[Late #], IF('Production order'[Total orders] = 0,
BLANK(), 0)) / 'Production order'[Total orders], BLANK())

On-time & in full COUNTROWS(FILTER('Production order', 'Production
order'[Is in full] = TRUE && 'Production order'[Is delayed] =
FALSE && 'Production order'[Is early] = FALSE))

M EA SUREM EA SURE H O W  T H E M EA SURE IS C A L C UL AT EDH O W  T H E M EA SURE IS C A L C UL AT ED



On-time & in full % IFERROR( IF('Production order'[On-time & in full] <> 0,
'Production order'[On-time & in full], IF('Production
order'[Completed] = 0, BLANK(), 0)) / 'Production
order'[Completed], BLANK())

Total orders COUNTROWS('Production order')

Total quantity SUM('Production order'[Good quantity]) + SUM('Production
order'[Defective quantity])

Defect rate (ppm) IF( 'Route transactions'[Processed quantity] = 0, BLANK(),
(SUM('Route transactions'[Defective quantity]) / 'Route
transactions'[Processed quantity]) * 1000000)

Defect ratio mixed (ppm) IF( 'Route transactions'[Total mixed quantity] = 0, BLANK(),
(SUM('Route transactions'[Defective quantity]) / 'Route
transactions'[Total mixed quantity]) * 1000000)

Processed quantity SUM('Route transactions'[Good quantity]) + SUM('Route
transactions'[Defective quantity])

Total mixed quantity SUM('Production order'[Good quantity]) + SUM('Route
transactions'[Defective quantity])

M EA SUREM EA SURE H O W  T H E M EA SURE IS C A L C UL AT EDH O W  T H E M EA SURE IS C A L C UL AT ED

EN T IT YEN T IT Y EXA M P L ES O F  AT T RIB UT ESEXA M P L ES O F  AT T RIB UT ES

Reported as finished date Completion (RAF) date, Month, and Year offset

Ended date Ended month offset and Month

Requirement date Requirement date month offset and Requirement date

Route transaction date Route transaction month offset and Date

Sites Sites ID, Site name, State, and City

Entities Id and Name

Resources Resource ID, Resource name, Resource type, and Resource
group

Products Product number, Product name, Item ID, and Item group

NOTENOTE

The following table shows the key dimensions that are used as filters to slice the aggregate measurements, so

that you can achieve greater granularity and gain deeper analytical insights.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Overview

Accessing the Power BI content pack

Metrics that are included in the Power BI content

This topic describes what's included in the Warehouse performanceWarehouse performance Microsoft Power BI content. It explains

how to access the Power BI reports, and provides information about the data model and entities that are used to

build the content.

The Warehouse performanceWarehouse performance Power BI content was created so that warehouse and operations managers can

monitor important inbound, outbound, and inventory metrics. It uses Warehouse management, product, and

other transactional data from your system, and provides both an aggregate view of warehouse performance

and a breakdown for vendors, product groups and products, and site and warehouses.

Warehouse managers can use the Warehouse performanceWarehouse performance Power BI content to measure the following three

areas:

Inbound performanceInbound performance – Measure how well a vendor is performing against customer requirements (in

other words, measure delivery performance), and measure put-away performance, so that you can identify

issues that involve workers or items over a period. It's important that you know whether vendors are

delivering on time, early, or late, so that you can determine how vendor performance is affecting overall put-

away performance. A vendor that delivers outside the dates that were agreed on can put extra pressure on

the warehouse because of unexpected work, and can increase the average put-away time.

Shipping performanceShipping performance – Measure whether your warehouse is shipping in full and on time to customers (in

other words, measure outbound shipping and delivery performance), so that you can identify any issues that

involve products, sites or warehouses, or dedicated customers. If you find that you're shipping late to specific

areas or towns, you might have to pay more attention to transportation or account management.

Location inventor y accuracyLocation inventor y accuracy  – Inventory accuracy is important internal warehouse business intelligence

(BI). It's very important that you determine how accurately you're counting in general. However, it's also

important that you determine how accurate you are at storing items in the correct locations, and that you

highlight discrepancy data, so that you can find better positions for items or initiate total counting on specific

items. (Currently, the new item-based counting functionality is delivered as a hotfix.) If you're using this

Power BI content to determine the correctness of on-hand inventory data per location, you can also identify

theft in your shops. You can also determine whether any locations have on-hand quantities that differ from

enterprise resource planning (ERP) data. Those locations might be too large, or they might be impossible to

count. Alternatively, some of the physical positioning might be bad, so that it's difficult to keep a single type

of item in sync with on-hand data.

The Warehouse performanceWarehouse performance Power BI content is shown on the Warehouse performanceWarehouse performance page

(Warehouse managementWarehouse management > Inquir ies and repor tsInquir ies and repor ts  > Warehouse performance analysisWarehouse performance analysis  > WarehouseWarehouse

performanceperformance).

The Warehouse performanceWarehouse performance Power BI content includes a report. This report consists of a set of metrics that

are visualized as charts, tiles, and tables. The following table provides an overview of the visualizations in the

Warehouse performanceWarehouse performance Power BI content.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/warehouse-power-bi-content.md
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Inbound Performance Total put aways The number of put-away work lines
that are processed during a given time.

Inbound Performance Put away average time The average time, in hours, for all
purchase order put-away lines that are
processed, from registration of the
items until the last put is processed.

Inbound Performance Received early The number of purchase order lines
that are received early.

Inbound Performance Received on time The number of purchase order lines
that are received on time.

Inbound Performance Received late The number of purchase order lines
that are received late.

Inbound Performance On time by vendor A view of the percentage of purchase
order lines that are received from a
vendor or vendor group early, on time,
and late.

Inbound Performance Dock to stock average put away
(hours)

The average dock-to-stock put-away
time in hours over time.

Inbound Performance Average put away by worker The average time, in hours, that a
worker has been taking for put-away
processing of purchase order lines.

Inbound Performance Average put away hour by vendor The average put-away time in hours by
vendor or vendor group.

Inbound Performance Average put away hour by product The average put-away time in hours by
item or item group.

Location inventory accuracy Total count The number of counting work lines
that are processed for a given period.

Location inventory accuracy Discrepancy rate The total discrepancy rate as a
percentage of all lines that are counted
for a given period.

Location inventory accuracy Count without discrepancy Of the total number of counting work
lines that are processed, the number of
lines that are processed without any
discrepancy.

Location inventory accuracy Items counted over time The percentage of items that are
counted with and without discrepancy
over time.



Location inventory accuracy Item quantity discrepancy greater than
%

A table view of counting lines that
have discrepancies that exceed a
specified percentage. The table
includes information about locations,
items, the average discrepancy, the
total counting work lines that are
counted, the number of counting lines
that have discrepancies for the
location, the average quantity that is
counted, the expected total quantity
that will be counted, and the actual
item quantity that is counted.

Location inventory accuracy Item count by worker The counting performance of workers.
Performance is expressed as a
percentage of counting work lines that
have and don't have discrepancies.

Location inventory accuracy Item count by site / warehouse Counting performance by the number
of processed counting work lines by
site or warehouse that have and don't
have discrepancies.

Location inventory accuracy Discrepancy rate by product The discrepancy rate for counting
performance. The rate is expressed as a
percentage of processed counting
work lines by item or item group.

Shipping performance Lines shipped The total number of shipment lines
that are shipped over a given period.

Shipping performance Early The percentage of shipment lines that
are shipped early.

Shipping performance On time The percentage of shipment lines that
are shipped on time.

Shipping performance Late The percentage of shipment lines that
are shipped late.

Shipping performance Shipments over time The percentage of shipment lines that
are shipped on time, early, or late over
a given period. A trend line shows the
trend for lines that are shipped on
time.

Shipping performance Shipped late by city A map visualization of cities and areas
that are affected by late shipments.

Shipping performance Shipped by product The percentage that is shipped early,
on time, or late by item or item group.

Shipping performance Shipped by customer The percentage that is shipped early,
on time, or late by customer or
customer group.

REP O RT  PA GEREP O RT  PA GE C H A RT SC H A RT S DESC RIP T IO NDESC RIP T IO N



Shipping performance Shipped by site / warehouse The percentage that is shipped early,
on time, or late by site or warehouse.

REP O RT  PA GEREP O RT  PA GE C H A RT SC H A RT S DESC RIP T IO NDESC RIP T IO N

Understanding the data model and calculations
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Inbound Performance Total put aways WHSWorkLine The count of work lines
where the work type is putput .

Inbound Performance Put away average time WHSWorkLine The sum of work lines max.
time divided by the count
of work lines max. time,
where work lines max. time
is the maximum gap
between the work created
date and the closed date.

Inbound Performance Received early WHSWorkLine The count of work lines
where the work created
date is earlier than the
delivery date that is used. If
the delivery confirmed date
isn't set, use the default
delivery date.

Inbound Performance Received on time WHSWorkLine The count of work lines
where the work created
date is equal to the delivery
date that is used. If the
delivery confirmed date isn't
set, use the default delivery
date.

Inbound Performance Received late WHSWorkLine The count of work lines
where the work created
date is later than the
delivery date that is used. If
the delivery confirmed date
isn't set, use the default
delivery date.

Inbound Performance On time by vendor WHSWorkLine Received early, Received on
time, and Received late (see
the descriptions earlier in
this table).

The following data is used to fill the report pages in the Warehouse performanceWarehouse performance Power BI content. This data

is represented as aggregate measurements that are staged in the Entity store. The Entity store is a Microsoft SQL

Server database that is optimized for analytics. For more information, see Power BI integration with Entity store.

The following key aggregate measurements are used as the basis of the content.



Inbound Performance Dock to stock average put
away (hours)

WHSWorkLine Put away average time (see
the description earlier in
this table).

Inbound Performance Average put away by
worker

WHSWorkLine Put away average time (see
the description earlier in
this table).

Inbound Performance Average put away hour by
vendor

WHSWorkLine Put away average time (see
the description earlier in
this table).

Inbound Performance Average put away hour by
product

WHSWorkLine Put away average time (see
the description earlier in
this table).

Location inventory accuracy Total count WHSWorkLineCycleCount Cycle counts where the
absolute discrepancy
quantity is equal to or more
than 0 (zero).

Location inventory accuracy Discrepancy rate WHSWorkLineCycleCount Cycle counts that have
discrepancies, divided by
the total count. A cycle
count is considered to have
discrepancies if the absolute
discrepancy quantity is
more than 0 (zero).

Location inventory accuracy Count without discrepancy WHSWorkLineCycleCount Cycle counts where the
absolute discrepancy
quantity is more than 0
(zero).

Location inventory accuracy Count with discrepancy WHSWorkLineCycleCount Cycle counts where the
absolute discrepancy
quantity is equal to 0 (zero).

Location inventory accuracy Items counted over time WHSWorkLineCycleCount Count without discrepancy
and Count with discrepancy
(See the descriptions earlier
in this table.)
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Location inventory accuracy Item quantity discrepancy
greater than %

WHSWorkLineCycleCount The average discrepancy is
the absolute discrepancy
quantity divided by the
expected quantity where
the absolute discrepancy
quantity is more than 0
(zero). The average
discrepancy quantity is the
average absolute
discrepancy quantity where
the absolute discrepancy
quantity is more than 0
(zero). Count with
discrepancy, Total count,
Expected quantity, and
Counted quantity where
the whole quantity is
grouped by item and
location (see the
descriptions earlier in this
table).

Location inventory accuracy Item count by worker WHSWorkLineCycleCount Count without discrepancy
and Count with discrepancy
(see the descriptions earlier
in this table).

Location inventory accuracy Item count by site /
warehouse

WHSWorkLineCycleCount Count without discrepancy
and Count with discrepancy
(see the descriptions earlier
in this table).

Location inventory accuracy Discrepancy rate by product WHSWorkLineCycleCount Discrepancy rate (see the
description earlier in this
table).

Shipping performance Lines shipped SalesLine The count of sales lines
where sales lines are
shipped.

Shipping performance Early CustPackingSlipOnTimeStat
us

Sales lines where the ship
date status is 1 (Early)1 (Early) .
Early means that the ship
date of the packing slip is
earlier than the confirmed
ship date of the sales line. If
the confirmed ship date
isn't set, use the requested
ship date.
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Shipping performance On time CustPackingSlipOnTimeStat
us

Sales lines where the ship
date status is 2 (On time)2 (On time).
On time means that the
ship date of the packing slip
is equal to the confirmed
ship date of the sales line. If
the confirmed ship date
isn't set, use the requested
ship date.

Shipping performance Late CustPackingSlipOnTimeStat
us

Sales lines where the ship
date status is 3 (Late)3 (Late). Late
means that the ship date of
the packing slip is later than
the confirmed ship date of
the sales line. If the
confirmed ship date isn't
set, use the requested ship
date.

Shipping performance Shipments over time SalesLine
CustPackingSlipOnTimeStat
us

Orders that are fully
shipped, where the whole
quantity of the sales line is
shipped, plus Early, On time,
and Late (see the
descriptions earlier in this
table).

Shipping performance Shipped late by city CustPackingSlipOnTimeStat
us

Late (see the descriptions
earlier in this table).

Shipping performance Shipped by product CustPackingSlipOnTimeStat
us

Early, On time, and Late
(see the descriptions earlier
in this table).

Shipping performance Shipped by customer CustPackingSlipOnTimeStat
us

Early, On time, and Late
(see the descriptions earlier
in this table).

Shipping performance Shipped by site / warehouse CustPackingSlipOnTimeStat
us

Early, On time, and Late
(see the descriptions earlier
in this table).
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NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Overview

Power BI in workspaces

Dynamics Finance and Operations apps now deliver rich, interactive reports seamlessly integrated into

application workspaces. By using graphics and visuals supported by Power BI, workspaces can provide a highly-

visual, yet interactive experiences for users.

Workspaces in the application provide an overview of business processes or business units. With rich

workspaces, users can get a bird's-eye view of the state of business before diving into details and taking action.

Workspaces contain visuals, count tiles, and KPIs as well as quick links to reports and pages. Within a workspace,

all controls are tightly integrated to provide a highly-productive and engaging work environment to the user.

Power BI Embedded is a Microsoft Azure service that enables ISVs and app developers to surface Power BI data

experiences within their applications. With Power BI Embedded, developers can deliver always-up-to-date views

with Direct Query. To learn more about how the Power BI Embedded service integrates with the application, see

Power BI Embedded integration.

The application now delivers interactive reports that seamlessly integrate into application workspaces. By using

rich infographics and visuals supported by Power BI (including the large number of controls provided by third

parties), workspaces can provide a highly-visual, yet interactive experience for users. Using infographics in the

overview page, users can get a quick glance of the state of the business. They can interact with data by simply

clicking or touching visuals on the page. They can see the cause and effect, perform simple what-if operations

without leaving the workspace. Thanks to stunning yet interactive visuals, your users will have fun exploring

data and discovering hidden trends.

The following screenshot shows Power BI in a workspace.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/embed-power-bi-workspaces.md


Power BI vs operational workspaces

Edit embedded reports in analytical workspaces

Power BI workspaces complement operational views with analytical insights based on near real-time

information. The following offers a visual comparison of a Power BI workspace and an operational workspace.

The following screenshot shows an operational workspace.



What's next?

NOTENOTE

The How to edit an embedded report in an analytical workspace video (shown above) is included in the Playlist

available on YouTube.

Going forward, new cloud deployments will come bundled with the Power BI Embedded service. Additional

documentation describing the Developer ALM process will be made available to help partners and ISVs create

new solutions that take advantage of the Power BI Embedded service integration options that are available.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://www.microsoft.com/videoplayer/embed/RE3nnj4
https://youtu.be/_8WlwmSggcQ
https://www.youtube.com/playlist?list=PLcakwueIHoT_SYfIaPGoOhloFoCXiUSyW
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Overview

Advantages of Power BI Embedded

Microsoft Power BI content that partners and independent software vendors (ISVs) developed can be embedded

directly into the Microsoft Dynamics 365 Finance. This topic describes some of the ways that you can use the

Microsoft Power BI Embedded integration.

The integration of the application and Power BI enables data mash-up scenarios that require access to external

data sources that are supported through Microsoft Power Query for Excel. Users can personalize workspaces by

embedding tiles that are hosted on PowerBI.com. Users can also add direct links to reports that are hosted on

PowerBI.com. In this way, users can access and interact with the reports without leaving the application. Power BI

content (PBIX files) that partners and ISVs develop can be embedded directly into the application. PBIX files that

are associated with a model file are automatically published in Power BI Embedded as part of the application

deployment process. Additionally, you can add X++ extensions for embedded reporting scenarios that require

the following functionality:

Drill-down navigation into detailed pages in response to user interactions

Report filters that are based on user and session context information, such as company or date range

The ability to navigate directly to a specific tab on a Power BI report via menu items

For more information about customizations that use extensions, see Customize through extension and

overlayering.

Deliver Power BI workspaces and repor ts in the application.Deliver Power BI workspaces and repor ts in the application. If you're a power user or a business

analyst, you can tweak ready-made reports or create new reports by using Power BI tools. As a developer,

you can use the reports that your users create to provide rich navigation experiences in the product through

workspaces. If you're in the partner and ISV community, you can build rich workspaces that include Power BI

experiences, and then release those workspaces as part of your solution.

The Power BI Embedded ser vice license is bundled with the application.The Power BI Embedded ser vice license is bundled with the application. If you're an ISV or a

systems integrator, you can package workspaces that are enabled for Power BI (and navigational experiences

that those workspaces provide) as part of a Microsoft Dynamics Lifecycle Services (LCS) solution. Your

customers get the same experience without having to have a PowerBI.com subscription. The workspaces just

work with Finance and Operations applications.

Enable dr ill-down into detailed pages from Power BI.Enable dr ill-down into detailed pages from Power BI. The visuals are the starting point for action. Your

users can drill down to business processes and pages to act immediately on issues that they uncover. The

visuals let users filter data and uncover trends. Action pages reflect just the set of data that requires attention.

Help secure access to Power BI repor ts by using menu items.Help secure access to Power BI repor ts by using menu items. As a developer, you can use familiar

programming concepts that are available in Finance and Operations apps, because we have extended the

same concepts to workspaces that are based on Power BI. You can create new workspaces or extend existing

workspaces by adding an overview page that is driven by Power BI. Developers can associate menu items

with Power BI reports and include them as links in workspaces. The role-based and task-based security in

Finance and Operations apps can be used to help secure these menu items.

Filter  repor ts based on application context.Filter  repor ts based on application context. You can build navigation experiences by passing one or

more filters to Power BI reports. For example, depending on a user ’s actions or context, you can filter the

Power BI report to reflect data from one business unit or a specific product. The user doesn't have to filter the

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/power-bi-embedded-integration.md
https://www.powerbi.com/
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/extensibility/customization-overlayering-extensions


Service availability

Frequently asked questions
Can I customize the Power BI embedded reports?Can I customize the Power BI embedded reports?

Do customers have to purchase a separate Power BI license to use the new embedded analytics?Do customers have to purchase a separate Power BI license to use the new embedded analytics?

Can I do data mash-ups by using external data in the embedded reports?Can I do data mash-ups by using external data in the embedded reports?

Can I help secure data to only those companies that I have access to?Can I help secure data to only those companies that I have access to?

How is currency shown across multiple companies?How is currency shown across multiple companies?

Can I drill from summary balances back into Finance and Operations?Can I drill from summary balances back into Finance and Operations?

What languages are currently supported?What languages are currently supported?

Can I access analytical workspaces and reports in the on-premises version of Finance and Operations?Can I access analytical workspaces and reports in the on-premises version of Finance and Operations?

NOTENOTE

data. You can define drill-through links to Finance and Operations pages, so that users can go directly to the

transactional details pages.

For more information about the Power BI Embedded service, see the Power BI FAQ.

The Power BI Embedded ser vice is automatically deployed and configured for all cloud-hosted,The Power BI Embedded ser vice is automatically deployed and configured for all cloud-hosted,

multi-box deployments.multi-box deployments. Because the service relies on Microsoft Azure services, application analytical

workspaces and reports are unavailable in one-box environments. The Power BI Embedded service is already

available in most Azure datacenters. You can check the latest availability on the Azure status page.

Yes. To customize the Power BI embedded reports, just install Power BI Desktop in a one-box environment, and

follow the steps in Create analytical reports by using Power BI Desktop.

No, customers don't have to purchase a separate Power BI license to use the new embedded analytics. However,

a Power BI Pro license is required in order to connect to Entity Store from PowerBI.com by using DirectQuery.

No, you can't currently do data mash-ups by using external data in the embedded reports.

Yes, the single company view prevents users from accessing data from companies that they don’t have access to.

For more information about how to help secure custom solutions, see Help secure analytical workspaces and

reports by using Power BI Embedded.

Currency is shown as a system currency. The system currency is defined on the System parametersSystem parameters  page .

Yes, you can drill into the details on a Power BI report. However, there is limited support for drill-down into

Finance and Operations apps.

Currently, only English is supported. However, the Power BI team plans to add support for other languages.

No, you can't currently access analytical workspaces and reports in Dynamics 365 Finance + Operations (on-

premises). Systems of Intelligence functions rely on cloud-hosted solutions.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://powerbi.microsoft.com/documentation/powerbi-frequently-asked-questions/
https://azure.microsoft.com/status/
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Analytical workspaces

IMPORTANTIMPORTANT

Edit embedded reports in analytical workspacesEdit embedded reports in analytical workspaces

Important points about embedded analytical reportsImportant points about embedded analytical reports

Customize an analytical workspace

Analytical workspaces are bundled with the application suite. Through reporting, they offer users insights into

data that is based on standard business operations. The reports are generic reports that are defined by business

professionals. They include metrics that are considered interesting to a wide range of users from any industry.

However, in some cases, the standard reports include data that isn't relevant to all customers. More often,

customers might want to access data points or calculations that are left out of the standard reports.

Power users can use web-friendly design tools to customize the analytical reports that are embedded in the

application. By using the free-form canvas designer, users who are familiar with the relevant business insights

that are required can help make the organization successful.

Customizations that are made to the embedded analytical reports are automatically deployed by the service and made

available to other users of the system.

The How to edit an embedded report in an analytical workspace video (shown above) is included in the Playlist

available on YouTube.

Although the standard reports deliver insights that are tailored to a given business persona, customizations can

often maximize the value of these standard reports.

Here are some important points to note about this service capability:

Customizations are limited to the report design canvas. Users can't change the definitions of report data sets.

Report customizations that are made to the analytical workspace apply to all users in the environment.

The service automatically preserves report customizations during product upgrades.

The service doesn't support the export of customizations that are made to analytical workspaces.

To customize the embedded application solutions, a user must be a member of the System Report Editors

security group. Members of this security group can do customizations by using the buttons on the OptionsOptions  tab

on the Action Pane of the application workspaces. This example shows how to customize one of the standard

analytical workspaces that are bundled with the application suite.

1. Sign in and open the application workspace that you want to customize. In this example, you will replace

the standard analytical report that is embedded in the Compensation managementCompensation management workspace.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/customize-analytical-workspace.md
https://www.microsoft.com/videoplayer/embed/RE3nnj4
https://youtu.be/_8WlwmSggcQ
https://www.youtube.com/playlist?list=PLcakwueIHoT_SYfIaPGoOhloFoCXiUSyW


NOTENOTE

2. Select the AnalyticsAnalytics  tab to access the workspace's embedded analytical report.

By default, you see the standard analytical workspace solution that is packaged with your application. The

reports in this solution are automatically deployed and configured for your environment during the

provisioning process.

The analytical workspaces require a hosted Microsoft Power BI service that is available only for dedicated

environments. For more information, see Accessing Analytical Workspaces and Reports on 1Box environment.

3. On the Action Pane, on the OptionsOptions  tab, in the Power BIPower BI group, select Edit AnalyticsEdit Analytics .

https://blogs.msdn.microsoft.com/dynamicsaxbi/2017/07/29/accessing-analytical-workspaces-on-1box-environment/


Restore the standard application solution

NOTENOTE

The analytical workspace is opened in edit mode, and you have direct access to the Power BI web

designer tools.

4. Use the Power BI web designer tools to customize the report canvas. The intuitive web controls let you

perform typical actions such as adding and removing visuals, changing visual types, and formatting the

content. You can also inspect the source of the report visualizations to make sure that decisions are based

on the most relevant data that is available in the system. For more information, see Add visualizations to

a Power BI report.

5. After you've completed your report customizations, select the SaveSave button to promote the report edits.

Customizations to the report are reflected immediately in the service. Therefore, users in your

organization have access to the latest innovations.

Customizations made in the web editor are not saved back to the underlying PBIX report and are not retrievable if

the PBIX report is later customized on a development environment.

Follow these steps to restore the analytical workspaces that are bundled with the application solution.

1. In the analytical workspace, on the Action Pane, on the OptionsOptions  tab, in the Power BIPower BI group, select RestoreRestore

AnalyticsAnalytics .

2. To view the updates to the workspace, reload the page. Either move away from the workspace and then

return, or refresh your browser.

3. In the Compensation managementCompensation management workspace, select the AnalyticsAnalytics  tab to access the original analytical

workspace that was packaged with the application.

https://docs.microsoft.com/en-us/power-bi/visuals/power-bi-report-add-visualizations-i


Troubleshooting

NOTENOTE

Follow these steps to address common issues encountered while attempting to use analytical workspaces.

Error message:Error message: Please log into Power BI to access its resourcePlease log into Power BI to access its resource

The Power BI service requires explicit permission from the user to allow access to hosted content. Use the

following steps to ensure the current user is able to connect to reports hosted on PowerBI.com from the

application suite.

1. Open any application workspace containing a section titled L inkLink . For example, "Bank management".

2. Select OptionsOptions , and then select Open repor t catalogOpen repor t catalog on the top left.

3. Follow the steps in the dialog box to Authorize to Power BIAuthorize to Power BI to access Finance and Operations apps for the

current user.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Document Reporting Services

Service deployment – Local vs. cloudService deployment – Local vs. cloud

Viewing reportsViewing reports

This article describes the integrated reporting solution that are available. This solution simplifies service

administration, increases developer productivity, and provides an enhanced report viewing experience for users.

Document Reporting Services are based on Microsoft SQL Server Reporting Services (SSRS). In the current

version of the application, these services are hosted in the Microsoft Azure compute service. If you're developing

in a one-box environment, the services also run locally in the Azure compute emulator.

In a one-box environment, developers can create, modify, and preview reports, from end to end, by using

Microsoft Visual Studio. A separate process isn't required in order to add reports to the application's metadata

store. Changes to reports are packaged together with other solution updates and then deployed to the cloud

after development is completed in the local environment.

The enhanced report viewing experience that provides for end users is the same as the report preview

experience in Microsoft Visual Studio. You no longer use a separate design preview in Visual Studio. Instead, just

press Ctrl+F5 to build and preview the report in an Internet Explorer window. The report appears exactly as it

would appear in the client. Even the user's parameter experience is the same. The following screen shot shows

an example of a report preview that is opened from Visual Studio.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/document-reporting-services.md


Service administration prerequisites
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A report development environment has the following
prerequisites:

Reporting services run in the Azure compute emulator,
together with the application server. Therefore, there are no
SSRS service administration prerequisites. After reports have
been deployed to the local reporting services, they can be
accessed from the client.

Developing application reports

The following table compares the service administration prerequisites for Microsoft Dynamics AX 2012 and the

current version of the application.

SSRS must be installed.

SSRS must be configured by using Reporting Services
Configuration Manager.

SSRS extensions for the application must be installed.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/2_report.png
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NOTENOTE

The process for developing a report in the current version is easier than it is in AX 2012, because you can create

and validate a reporting solution entirely in Visual Studio. The following table describes how the application

simplifies the basic procedure for adding an automatic design report that is based on a query.

1. In the application, create a query in the Application
Object Tree (AOT).

2. In Visual Studio, create a reporting project, and add
the query to it.

3. Edit the report in the Visual Studio model editor.

4. Preview the report design in Visual Studio by using
the model editor toolbar.

5. Use Visual Studio to add the report to the AOT.

6. Use the AOT in the client to create a menu item for
the report, and add the menu item to a menu.

7. Use the AOT to deploy the report to the report
server.

8. Verify the report in the client.

1. In Visual Studio, create a reporting project and the
query.

2. Edit the report in Visual Studio.

3. In Visual Studio, add the report to a menu item, and
set the menu item as a startup object.

4. Use the AOT to deploy the report to the report
server.

5. Press Ctrl+F5 to verify the report in the application.

[!NOTE] There is no longer a separate preview of
the report design from the model editor.

6. When the whole solution is completed, deploy it to
the cloud in one package.
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Supported fonts for application version 8.3 with Platform update 32
or later
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Agency FB Office font

Algerian Office font

Arial Finance and Operations font

Arial Black Finance and Operations font

Arial Narrow Finance and Operations font

Arial Rounded MT Bold Office font

Baskerville Old Face Office font

Bauhaus 93 Office font

BC C128 HD Medium Finance and Operations font

BC C128 HD Narrow Finance and Operations font

BC C128 HD Wide Finance and Operations font

BC C128 Medium Finance and Operations font

BC C128 Narrow Finance and Operations font

BC C128 Wide Finance and Operations font

BC C39 2 to 1 HD Medium Finance and Operations font

BC C39 2 to 1 HD Narrow Finance and Operations font

Finance and Operations apps include access to hundreds of standard, business-ready fonts available for

documents rendered by the cloud-hosted service.

This portfolio will continue to grow as the service expands into new regions and industries. However, the service

no longer supports the installation of custom fonts in customer environments. Requests to expand the collection

of fonts supported by the service will be considered on a case-by-case basis.

The following list captures the portfolio of font families available for documents produced using SQL Server

Reporting Services (SSRS) services in Finance and Operations apps.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/supported-fonts.md


BC C39 2 to 1 HD Wide Finance and Operations font

BC C39 2 to 1 Medium Finance and Operations font

BC C39 2 to 1 Narrow Finance and Operations font

BC C39 2 to 1 Wide Finance and Operations font

BC C39 3 to 1 HD Medium Finance and Operations font

BC C39 3 to 1 HD Narrow Finance and Operations font

BC C39 3 to 1 HD Wide Finance and Operations font

BC C39 3 to 1 Medium Finance and Operations font

BC C39 3 to 1 Narrow Finance and Operations font

BC C39 3 to 1 Wide Finance and Operations font

BC CBar 2 to 1 HD Medium Finance and Operations font

BC CBar 2 to 1 HD Narrow Finance and Operations font

BC CBar 2 to 1 HD Wide Finance and Operations font

BC CBar 2 to 1 Medium Finance and Operations font

BC CBar 2 to 1 Narrow Finance and Operations font

BC CBar 2 to 1 Wide Finance and Operations font

BC CBar 3 to 1 HD Medium Finance and Operations font

BC CBar 3 to 1 HD Narrow Finance and Operations font

BC CBar 3 to 1 HD Wide Finance and Operations font

BC CBar 3 to 1 Medium Finance and Operations font

BC CBar 3 to 1 Narrow Finance and Operations font

BC CBar 3 to 1 Wide Finance and Operations font

BC I25 HD Medium Finance and Operations font

BC I25 HD Narrow Finance and Operations font

BC I25 HD Wide Finance and Operations font
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BC I25 Medium Finance and Operations font

BC I25 Narrow Finance and Operations font

BC I25 Wide Finance and Operations font

BC Postnet Finance and Operations font

BC UPC HD Medium Finance and Operations font

BC UPC HD Narrow Finance and Operations font

BC UPC HD Wide Finance and Operations font

BC UPC Medium Finance and Operations font

BC UPC Narrow Finance and Operations font

BC UPC Wide Finance and Operations font

Bell MT Office font

Berlin Sans FB Office font

Berlin Sans FB Demi Office font

Bernard MT Condensed Office font

Blackadder ITC Office font

Bodoni MT Office font

Bodoni MT Black Office font

Bodoni MT Condensed Office font

Bodoni MT Poster Compres Office font

Book Antiqua Office font

Bookman Old Style Office font

Bookshelf Symbol 7 Office font

Bradley Hand ITC Office font

Britannic Bold Office font

Broadway Office font
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Brush Script MT Office font

Buxton Sketch Office font

Calibri Finance and Operations font

Calibri Light Finance and Operations font

Californian FB Office font

Calisto MT Office font

Cambria Finance and Operations font

Cambria Math Finance and Operations font

Candara Finance and Operations font

Castellar Office font

Centaur Office font

Century Office font

Century Gothic Office font

Century Schoolbook Office font

Chiller Office font

Colonna MT Office font

Comic Sans MS Finance and Operations font

Consolas Finance and Operations font

Constantia Finance and Operations font

Cooper Black Office font

Copperplate Gothic Bold Office font

Copperplate Gothic Light Office font

Corbel Finance and Operations font

Courier New Finance and Operations font

Curlz MT Office font
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DengXian Office font

Dotum Finance and Operations font

DotumChe Finance and Operations font

Ebrima Finance and Operations font

Edwardian Script ITC Office font

Elephant Office font

Engravers MT Office font

Eras Bold ITC Office font

Eras Demi ITC Office font

Eras Light ITC Office font

Eras Medium ITC Office font

Felix Titling Office font

Footlight MT Light Office font

Forte Office font

Franklin Gothic Book Office font

Franklin Gothic Demi Office font

Franklin Gothic Demi Con Office font

Franklin Gothic Heavy Office font

Franklin Gothic Medium Finance and Operations font

Franklin Gothic Medium C Office font

Freestyle Script Office font

French Script MT Office font

Gabriola Finance and Operations font

Gadugi Finance and Operations font

Garamond Office font
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Georgia Finance and Operations font

Gigi Office font

Gill Sans MT Office font

Gill Sans MT Condensed Office font

Gill Sans MT Ext Condens Office font

Gill Sans Ultra Bold Office font

Gill Sans Ultra Bold Con Office font

Gloucester MT Extra Cond Office font

Goudy Old Style Office font

Goudy Stout Office font

Gulim Finance and Operations font

GulimChe Finance and Operations font

Haettenschweiler Office font

Harlow Solid Italic Office font

Harrington Office font

High Tower Text Office font

IDAutomationMICR Finance and Operations font

Impact Finance and Operations font

Imprint MT Shadow Office font

Informal Roman Office font

Javanese Text Finance and Operations font

Jokerman Office font

Juice ITC Office font

Kristen ITC Office font

Kunstler Script Office font
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Leelawadee Office font

Leelawadee UI Finance and Operations font

Leelawadee UI Semilight Finance and Operations font

Lucida Bright Office font

Lucida Calligraphy Office font

Lucida Console Finance and Operations font

Lucida Fax Office font

Lucida Handwriting Office font

Lucida Sans Office font

Lucida Sans Typewriter Office font

Lucida Sans Unicode Finance and Operations font

Magneto Office font

Maiandra GD Office font

Malgun Gothic Finance and Operations font

Malgun Gothic Semilight Finance and Operations font

Marlett Finance and Operations font

Matura MT Script Capital Office font

MICR E13B 2.1 Finance and Operations font

Microsoft Himalaya Finance and Operations font

Microsoft JhengHei Finance and Operations font

Microsoft JhengHei Light Finance and Operations font

Microsoft JhengHei UI Finance and Operations font

Microsoft JhengHei UI Li Office font

Microsoft MHei Office font

Microsoft NeoGothic Office font
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Microsoft New Tai Lue Finance and Operations font

Microsoft PhagsPa Finance and Operations font

Microsoft Sans Serif Finance and Operations font

Microsoft Tai Le Finance and Operations font

Microsoft Uighur Office font

Microsoft YaHei Finance and Operations font

Microsoft YaHei Light Finance and Operations font

Microsoft YaHei UI Finance and Operations font

Microsoft YaHei UI Light Finance and Operations font

Microsoft Yi Baiti Finance and Operations font

MingLiU Finance and Operations font

MingLiU-ExtB Finance and Operations font

MingLiU_HKSCS Finance and Operations font

MingLiU_HKSCS-ExtB Finance and Operations font

Mistral Office font

Modern No. 20 Office font

Mongolian Baiti Finance and Operations font

Monotype Corsiva Office font

MS Gothic Finance and Operations font

MS Outlook Office font

MS PGothic Finance and Operations font

MS Reference Sans Serif Office font

MS Reference Specialty Office font

MS UI Gothic Finance and Operations font

MT Extra Office font
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MV Boli Finance and Operations font

Myanmar Text Finance and Operations font

Niagara Engraved Office font

Niagara Solid Office font

Nirmala UI Finance and Operations font

Nirmala UI Semilight Finance and Operations font

NSimSun Finance and Operations font

OCR A Extended Office font

OCRB Finance and Operations font

Old English Text MT Office font

Onyx Office font

Palace Script MT Office font

Palatino Linotype Finance and Operations font

Papyrus Office font

Parchment Office font

Perpetua Office font

Perpetua Titling MT Office font

Playbill Office font

PMingLiU Finance and Operations font

PMingLiU-ExtB Finance and Operations font

Poor Richard Office font

Pristina Office font

Rage Italic Office font

Ravie Office font

Rockwell Office font
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Rockwell Condensed Office font

Rockwell Extra Bold Office font

Script MT Bold Office font

Segoe Marker Office font

Segoe MDL2 Assets Finance and Operations font

Segoe Print Finance and Operations font

Segoe Script Finance and Operations font

Segoe UI Finance and Operations font

Segoe UI Black Finance and Operations font

Segoe UI Emoji Finance and Operations font

Segoe UI Historic Finance and Operations font

Segoe UI Light Finance and Operations font

Segoe UI Semibold Finance and Operations font

Segoe UI Semilight Finance and Operations font

Segoe UI Symbol Finance and Operations font

Segoe WP Office font

Segoe WP Black Office font

Segoe WP Light Office font

Segoe WP Semibold Office font

Segoe WP SemiLight Office font

Showcard Gothic Office font

SimSun Finance and Operations font

SimSun-ExtB Finance and Operations font

Sitka Banner Finance and Operations font

Sitka Display Finance and Operations font
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Sitka Heading Finance and Operations font

Sitka Small Finance and Operations font

Sitka Subheading Finance and Operations font

Sitka Text Finance and Operations font

SketchFlow Print Office font

Snap ITC Office font

Stencil Office font

Sylfaen Finance and Operations font

Symbol Finance and Operations font

Tahoma Finance and Operations font

Tempus Sans ITC Office font

Times New Roman Finance and Operations font

Trebuchet MS Finance and Operations font

Tw Cen MT Office font

Tw Cen MT Condensed Office font

Tw Cen MT Condensed Extr Office font

Verdana Finance and Operations font

Viner Hand ITC Office font

Vivaldi Office font

Vladimir Script Office font

Webdings Finance and Operations font

Wide Latin Office font

Wingdings Finance and Operations font

Wingdings 2 Office font

Wingdings 3 Office font
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Yu Gothic Finance and Operations font

Yu Gothic Light Finance and Operations font

Yu Gothic Medium Finance and Operations font

Yu Gothic UI Finance and Operations font

Yu Gothic UI Light Finance and Operations font

Yu Gothic UI Semibold Finance and Operations font

Yu Gothic UI Semilight Finance and Operations font
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Supported fonts for application version 8.0 with Platform update 23
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1 Agency FB

2 Algerian

3 Arial

4 Arial Black

5 Arial Narrow

6 Arial Rounded MT Bold

7 Baskerville Old Face

8 Bauhaus 93

9 BC C128 HD Medium

10 BC C128 HD Narrow

11 BC C128 HD Wide

12 BC C128 Medium

13 BC C128 Narrow

14 BC C128 Wide

15 BC C39 2 to 1 HD Medium

16 BC C39 2 to 1 HD Narrow



17 BC C39 2 to 1 HD Wide

18 BC C39 2 to 1 Medium

19 BC C39 2 to 1 Narrow

20 BC C39 2 to 1 Wide

21 BC C39 3 to 1 HD Medium

22 BC C39 3 to 1 HD Narrow

23 BC C39 3 to 1 HD Wide

24 BC C39 3 to 1 Medium

25 BC C39 3 to 1 Narrow

26 BC C39 3 to 1 Wide

27 BC CBar 2 to 1 HD Medium

28 BC CBar 2 to 1 HD Narrow

29 BC CBar 2 to 1 HD Wide

30 BC CBar 2 to 1 Medium

31 BC CBar 2 to 1 Narrow

32 BC CBar 2 to 1 Wide

33 BC CBar 3 to 1 HD Medium

34 BC CBar 3 to 1 HD Narrow

35 BC CBar 3 to 1 HD Wide

36 BC CBar 3 to 1 Medium

37 BC CBar 3 to 1 Narrow

38 BC CBar 3 to 1 Wide

39 BC I25 HD Medium

40 BC I25 HD Narrow

41 BC I25 HD Wide
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42 BC I25 Medium

43 BC I25 Narrow

44 BC I25 Wide

45 BC Postnet

46 BC UPC HD Medium

47 BC UPC HD Narrow

48 BC UPC HD Wide

49 BC UPC Medium

50 BC UPC Narrow

51 BC UPC Wide

52 Bell MT

53 Berlin Sans FB

54 Berlin Sans FB Demi

55 Bernard MT Condensed

56 Blackadder ITC

57 Bodoni MT

58 Bodoni MT Black

59 Bodoni MT Condensed

60 Bodoni MT Poster Compres

61 Book Antiqua

62 Bookman Old Style

63 Bookshelf Symbol 7

64 Bradley Hand ITC

65 Britannic Bold

66 Broadway
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67 Brush Script MT

68 Buxton Sketch

69 Calibri

70 Calibri Light

71 Californian FB

72 Calisto MT

73 Cambria

74 Cambria Math

75 Candara

76 Castellar

77 Centaur

78 Century

79 Century Gothic

80 Century Schoolbook

81 Chiller

82 Colonna MT

83 Comic Sans MS

84 Consolas

85 Constantia

86 Cooper Black

87 Copperplate Gothic Bold

88 Copperplate Gothic Light

89 Corbel

90 Courier New

91 Curlz MT
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92 DengXian

93 Dotum

94 DotumChe

95 Ebrima

96 Edwardian Script ITC

97 Elephant

98 Engravers MT

99 Eras Bold ITC

100 Eras Demi ITC

101 Eras Light ITC

102 Eras Medium ITC

103 Felix Titling

104 Footlight MT Light

105 Forte

106 Franklin Gothic Book

107 Franklin Gothic Demi

108 Franklin Gothic Demi Con

109 Franklin Gothic Heavy

110 Franklin Gothic Medium

111 Franklin Gothic Medium C

112 Freestyle Script

113 French Script MT

114 Gabriola

115 Gadugi

116 Garamond
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117 Georgia

118 Gigi

119 Gill Sans MT

120 Gill Sans MT Condensed

121 Gill Sans MT Ext Condens

122 Gill Sans Ultra Bold

123 Gill Sans Ultra Bold Con

124 Gloucester MT Extra Cond

125 Goudy Old Style

126 Goudy Stout

127 Gulim

128 GulimChe

129 Haettenschweiler

130 Harlow Solid Italic

131 Harrington

132 High Tower Text

133 IDAutomationMICR

134 Impact

135 Imprint MT Shadow

136 Informal Roman

137 Javanese Text

138 Jokerman

139 Juice ITC

140 Kristen ITC

141 Kunstler Script
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142 Leelawadee

143 Leelawadee UI

144 Leelawadee UI Semilight

145 Lucida Bright

146 Lucida Calligraphy

147 Lucida Console

148 Lucida Fax

149 Lucida Handwriting

150 Lucida Sans

151 Lucida Sans Typewriter

152 Lucida Sans Unicode

153 Magneto

154 Maiandra GD

155 Malgun Gothic

156 Malgun Gothic Semilight

157 Marlett

158 Matura MT Script Capital

159 MICR E13B 2.1

160 Microsoft Himalaya

161 Microsoft JhengHei

162 Microsoft JhengHei Light

163 Microsoft JhengHei UI

164 Microsoft JhengHei UI Li

165 Microsoft MHei

166 Microsoft NeoGothic
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167 Microsoft New Tai Lue

168 Microsoft PhagsPa

169 Microsoft Sans Serif

170 Microsoft Tai Le

171 Microsoft Uighur

172 Microsoft YaHei

173 Microsoft YaHei Light

174 Microsoft YaHei UI

175 Microsoft YaHei UI Light

176 Microsoft Yi Baiti

177 MingLiU

178 MingLiU-ExtB

179 MingLiU_HKSCS

180 MingLiU_HKSCS-ExtB

181 Mistral

182 Modern No. 20

183 Mongolian Baiti

184 Monotype Corsiva

185 MS Gothic

186 MS Outlook

187 MS PGothic

188 MS Reference Sans Serif

189 MS Reference Specialty

190 MS UI Gothic

191 MT Extra
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192 MV Boli

193 Myanmar Text

194 Niagara Engraved

195 Niagara Solid

196 Nirmala UI

197 Nirmala UI Semilight

198 NSimSun

199 OCR A Extended

200 OCRB

201 Old English Text MT

202 Onyx

203 Palace Script MT

204 Palatino Linotype

205 Papyrus

206 Parchment

207 Perpetua

208 Perpetua Titling MT

209 Playbill

210 PMingLiU

211 PMingLiU-ExtB

212 Poor Richard

213 Pristina

214 Rage Italic

215 Ravie

216 Rockwell
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217 Rockwell Condensed

218 Rockwell Extra Bold

219 Script MT Bold

220 Segoe Marker

221 Segoe MDL2 Assets

222 Segoe Print

223 Segoe Script

224 Segoe UI

225 Segoe UI Black

226 Segoe UI Emoji

227 Segoe UI Historic

228 Segoe UI Light

229 Segoe UI Semibold

230 Segoe UI Semilight

231 Segoe UI Symbol

232 Segoe WP

233 Segoe WP Black

234 Segoe WP Light

235 Segoe WP Semibold

236 Segoe WP SemiLight

237 Showcard Gothic

238 SimSun

239 SimSun-ExtB

240 Sitka Banner

241 Sitka Display
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242 Sitka Heading

243 Sitka Small

244 Sitka Subheading

245 Sitka Text

246 SketchFlow Print

247 Snap ITC

248 Stencil

249 Sylfaen

250 Symbol

251 Tahoma

252 Tempus Sans ITC

253 Times New Roman

254 Trebuchet MS

255 Tw Cen MT

256 Tw Cen MT Condensed

257 Tw Cen MT Condensed Extr

258 Verdana

259 Viner Hand ITC

260 Vivaldi

261 Vladimir Script

262 Webdings

263 Wide Latin

264 Wingdings

265 Wingdings 2

266 Wingdings 3
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267 Yu Gothic

268 Yu Gothic Light

269 Yu Gothic Medium

270 Yu Gothic UI

271 Yu Gothic UI Light

272 Yu Gothic UI Semibold

273 Yu Gothic UI Semilight
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NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Configure SQL Server Reporting Services for on-
premises deployments
2/18/2021 • 2 minutes to read • Edit Online

Use the steps in this topic to configure SQL Server Reporting Services (SSRS) for your Microsoft Dynamics 365

Finance + Operations (on-premises) deployment.

1. Open the Reporting Services Configuration Manager application.

2. Leave the default Ser ver nameSer ver name, which should be the name of the current machine, and the Repor tRepor t

Ser ver InstanceSer ver Instance, MSSQLSERVERMSSQLSERVER .

3. Click ConnectConnect.

4. Click the Ser vice AccountSer vice Account tab and verify that the settings match the following graphic.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/configure-ssrs-on-premises.md
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ssrs-config-manager-01.png


5. Click the Web Ser vice URLWeb Ser vice URL  tab and verify that the settings match the following graphic.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ssrs-config-manager-02.png


NOTENOTE

6. Click the DatabaseDatabase tab and verify that the Database NameDatabase Name and Credential settingsCredential settings  match the

following graphic.

You will need to create a new database. To do this, click Change DatabaseChange Database, and then verify that the new

database name is: DynamicsAxRepor tSer verDynamicsAxRepor tSer ver .

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ssrs-config-manager-03.png


NOTENOTE

7. Click the Web Por tal URLWeb Por tal URL  tab and verify that the settings match the following graphic.

You must click ApplyApply  to create and properly configure the Portal.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ssrs-config-manager-04.png


After the Portal is configured, the Web Por talWeb Por tal  tab will match the following graphic.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ssrs-config-manager-05.png


8. Click the reports URL to view the SQL Server Reporting Services web portal.

9. When you are in the portal, create a new folder named DynamicsDynamics .

10. In the Repor ting Ser vices Configuration ManagerRepor ting Ser vices Configuration Manager , click the E-mail SettingsE-mail Settings  tab and verify that the

settings match the following graphic.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ssrs-config-manager-06.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ssrs-config-manager-07.png


11. Click the Execution AccountExecution Account tab and verify that the settings match the following graphic.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ssrs-config-manager-08.png


Don't change the default settings on the Encr yption KeysEncr yption Keys  tab.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ssrs-config-manager-09.png


12. Click the Subscr iption SettingsSubscr iption Settings  tab, and verify that the settings match the following graphic.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ssrs-config-manager-10.png


Don't change the default settings on the Scale-out DeploymentScale-out Deployment tab.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ssrs-config-manager-11.png


Don't change the default settings on the Power BI IntegrationPower BI Integration tab.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ssrs-config-manager-12.png


13. Click ExitExit to close the Repor ting Ser vices Configuration ManagerRepor ting Ser vices Configuration Manager .

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ssrs-config-manager-13.png


NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ssrs-config-manager-14.png
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Printing overview

Application printing scenariosApplication printing scenarios
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1. Printing what you see Print what is currently shown in the
browser.

A "print-friendly" version of the
webpage is generated for the browser.

2. Interactive printing Print a precision document on a locally
connected device.

You can export a PDF version of the
report and download it to the browser.

3. Printing on a network device Send a precision document to a
domain printer device.

A precision document is sent to a
client application that runs on a server
that is hosted in the customer's
domain.

Service overview

You can print documents by using either a local printer or a network-connected device. This article provides an

overview of how documents are printed.

The application provides integrated services and client applications that make it easy to generate, store, and

distribute documents that support business activity. You can print documents by using either a local printer or a

network-connected device. In addition, you can export pages and reports directly from the client, as PDF files or

Microsoft Office documents. Finally, the distributed workload lets you print business documents directly from a

mobile device by using network resources. Although printing requirements might vary, all industries typically

must create hard copies of business documents by using the application. Printing documents on network

devices from hosted applications presents a unique set of challenges. Here are some examples:

Print drivers might not be available on the user's device.

The user's device might not be connected to the corporate network.

By using a dedicated host and following a few easy steps, system administrators can configure deployments so

that users can print directly from business applications on network devices.

The following table describes the three primary printing scenarios.

Because the solution varies, depending on the scenario, applications provide built-in services and tooling to help

users accomplish their goals:

Scenario 1Scenario 1  is supported by the browser's rendering of the HTML5 client.

Scenario 2Scenario 2  uses client applications and Microsoft 365 services.

Scenario 3Scenario 3  requires support from client applications and from services that are hosted in Microsoft Azure.

In addition to the platform that is deployed to the Azure subscription, Finance and Operations applications

provide customers with an integrated, first-party Azure application that helps them more easily use domain-

hosted devices to print documents.

While documents that are produced by the hosted applications are waiting to be printed on a network-

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/print-documents.md
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connected device, they are stored in Azure blob storage. The Install the Document Routing Agent to enable

network printing uses Azure authentication to establish a secure channel to the Azure services.

Execution sequenceExecution sequence

1. The report is generated by Microsoft SQL Server Reporting Services (SSRS) and stored in Azure blob

storage. Attached printer settings are stored together with the document.

2. The Document Routing Agent queries the Azure Service Bus queue for active jobs.

3. The document is downloaded by the Document Routing Agent and spooled to the network printer.

The client-based solution lets customers manage the scale of their printing needs. Customers who have heavy-

volume printing workloads can install many Document Routing Agents to increase the number of concurrent

printing operations. Alternatively, some customers require very few installations of the Document Routing Agent

to handle their anticipated printing needs.

The following diagram shows the basic components that help support network printing operations.

Note that a single printer can be registered with multiple Document Routing Agents. To resolve the printer

preferences, the hosted service uses the network path that uniquely identifies every network printer. As a result,

even when a printer is registered by multiple clients, it appears as a single selection in the list of printers

available in applications.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Preparing to install the Document Routing Agent

Key concepts

Install the Document Routing Agent

This topic describes how to install and configure the Document Routing Agent (DRA). The DRA is a

downloadable application that you can use to enable network printing scenarios. You can enable network

printers for specific companies by using in-client administrative pages.

Supported on Windows 8.1, Windows 10, Microsoft Windows Server 2012 R2, or Microsoft Windows Server

2016.

Access to network printing resources requires Active Directory Domain Services (AD DS) authentication.

When installing the DRA, make sure you are logged in as the Admin user.

The Microsoft Azure Active Directory (Azure AD) account that is used to configure the DRA must share the

same domain as the Azure tenant.

The DRA requires .NET 4.62 or later and Adobe Acrobat Reader on the client.

Configure Adobe client print settings to prevent document scaling.

Network printers that are registered for applications can be used by all legal entities (also known as companies)

that are defined in the environment. Network printer settings are company-specific. Therefore, administrators

can restrict access, based on the user's active company. For example, users in the active company might have

access to all the network printers that are registered by the Document Routing Agent. However, users in another

company won't have access to those printers until access is explicitly enabled for that company.

This topic will help you with the following tasks:

Identify the key components that are involved in the support for network printing in applications.

Learn about the function of the Document Routing Agent.

Configure the Document Routing Agent to work against an existing application.

Use administration pages to manage access to network printers.

Applications use the Document Routing Agent to manage the spooling of documents to network printer devices.

You can obtain the client by using direct links that are embedded in the web application. Use the following

procedure to download the application to your local computer. You will then be able to access both local and

network printers that are connected to your computer, from a single deployment.

1. Open the Manage network pr intersManage network pr inters  page (Organization administrationOrganization administration > SetupSetup > NetworkNetwork

printersprinters ).

2. On the OptionsOptions  tab, in the ApplicationApplication group, click Download document routing agent installerDownload document routing agent installer .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/install-document-routing-agent.md


Configure the Document Routing Agent

3. Run the downloaded file to begin the installation process.

4. Complete the setup process.

After the application is installed, you can begin to register local printers as network printers for the applications.

Use the following procedure to configure the client application so that it can communicate with the Azure

services that host the documents that are in-flight.

1. Close all browser instances that are running the application. This resets the local Azure authentication

tokens.

2. On your desktop, run the Document Routing Agent.

3. On the toolbar, click SettingsSettings .

4. Add the following settings:

Application IDApplication ID – The ID that is unique to the application and should be entered automatically.

Finance and Operations URLFinance and Operations URL  – The base URL of the application.

Azure AD tenantAzure AD tenant – The domain name of the Azure AD.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/download-document-routing-agent-installer.png
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5. Click OKOK.

6. Click S ign InSign In to sign in to your account.

The account must share the same domain as the Azure AD that is associated with the application. The Document

Routing Agent is now ready to process documents.

After you've successfully signed in, the Pr intersPr inters  button becomes available on the toolbar.

Before you complete this procedure, make sure that you've installed all the network printers on the local host

computer. All the printer devices that are installed will be available for service registration. Be sure to select only

the printers that you want to expose in the applications.

1. On the toolbar, click Pr intersPr inters .

2. Select the printers to make available in the applications.

3. Specify a default name for the printer.

4. Click OKOK.

After you've completed this procedure, the selected printer devices are registered in the application's network

printer catalog. System administrators can now enable the printers for access from within the application.

Use client pages to manage access to the network printers that have been registered by one or more Document

Routing Agents. Network printers are uniquely identified by their path. Therefore, printers are listed one time,

even if they have been registered by more than one Document Routing Agent. Use the following procedure to

activate the Application Object Server (AOS) network printers.

1. Open the Manage network pr intersManage network pr inters  page (Organization administrationOrganization administration > SetupSetup > NetworkNetwork

printersprinters ).

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/printers-to-add.png


Frequently asked questions
Does the Document Routing Agent have to be installed on each computer where a user connects by using aDoes the Document Routing Agent have to be installed on each computer where a user connects by using a
browser?browser?

If the Document Routing Agent belongs on a network Print Server, why doesn't the client run as a service?If the Document Routing Agent belongs on a network Print Server, why doesn't the client run as a service?

Do I need to update credentials or refresh Azure authentication tokens on a recurring basis?Do I need to update credentials or refresh Azure authentication tokens on a recurring basis?

Is the Document Routing Agent supported on Microsoft Windows Server 2019?Is the Document Routing Agent supported on Microsoft Windows Server 2019?

NOTENOTE

Will Microsoft add support for Microsoft Windows Server 2008 servers?Will Microsoft add support for Microsoft Windows Server 2008 servers?

Does the user who installs the Document Routing Agent have to be part of a Finance and Operations appsDoes the user who installs the Document Routing Agent have to be part of a Finance and Operations apps
security group?security group?

How many network printers can the Document Routing Agent support?How many network printers can the Document Routing Agent support?

2. Edit the existing entries that are mapped to each network printer. As part of your changes, edit the

connection path.

3. To include a printer as an option in the Pr int DestinationsPrint Destinations  field, set the ActiveActive field to YesYes .

The network printers can now be used in the application.

No. Client installations of the Document Routing Agent can be shared by individuals who access the provisioned

environment. We recommend that you install agents on one or more Print Servers or other domain-hosted

clients that have access to network printers.

The Document Routing Agent now supports running in the background as a service. You need to ensure that

you have downloaded the latest version of the client. For more information, see Run the Document Routing

Agent as a Windows service.

Yes. The Azure Active Directory token must be refreshed every 90 days. Failing to do so will prevent the DRA

from being able to authenticate and retrieve printing instructions applications.

Yes. The Document Routing Agent is supported on Microsoft Windows Server 2019.

If the server is configured to prevent background service, the Document Routing Agent client will not be able to run as a

service. For more information, see Run the Document Routing Agent as a Windows service.

No, not at this time. There are several dependencies on Azure capabilities that are available only in Microsoft

Windows Server 2012 R2 and Microsoft Windows Server 2016.

Yes. To access the agent installation links, the user must be part of the Document routing clientDocument routing client security role.

The number of supported network printers depends on the number of legal entities and the number of network

printers deployed. If you have fifty printers and one legal entity, a single Document Routing Agent can handle

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/manage-network-printers-page.png
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the load (although you'd want more than one to ensure high availability). If you have a large number of printers

and legal entities, we recommend that you do some performance testing to determine the number of Document

Routing Agents that you'll need.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Get started

The solution for managing the print job queue is designed to allow customers to properly scale Dynamics 365

Finance and Operations apps to satisfy high-volume printing requirements. Although public service endpoints

used to manage print jobs are backward-compatible, we strongly recommend that customers update allall

existing Document Routing Agent (DRA) clients.

If you don't update existing installations of the DRA the most current version, you might experience issues such

as:

Observable performance degradation in applications

Document loss that is associated with orphaned print jobs

Inconsistent handling of printed documents that have custom margins

IT administrators must perform the following procedures on each domain resource that is used to host a DRA.

When you complete a DRA update, IT administrators should register any printers that are connected through the host

server. For network printers that are identified by their network paths, if the paths have not changed, updates are not

required.

To continue to run the DRA as a Microsoft Windows service, you must have both the user name and the

password of the domain account that is used to run the service. This information must be available after the

update is completed. To find the information for the active service account, start the Microsoft Management

Console (MMC) Services snap-in, and select Microsoft Dynamics 365 Document Routing Ser viceMicrosoft Dynamics 365 Document Routing Ser vice in the

list.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/upgrade-document-routing-agent.md


Uninstall an existing Document Routing Agent
Open Programs and FeaturesPrograms and Features , and then find and uninstall Microsoft Dynamics 365 for Finance andMicrosoft Dynamics 365 for Finance and

Operations: Document RoutingOperations: Document Routing.



Install the latest Document Routing Agent
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During the uninstallation process, if you're prompted to close the Microsoft Dynamics 365 Document Routing

Service application, select Automatically close applications and attempt to restar t them after setup isAutomatically close applications and attempt to restar t them after setup is

complete.complete.

For information about how to install the latest DRA that is available with your subscription, see Install the

Document Routing Agent to enable network printing.

Be sure to open the DRA client after upgrading to refresh network user credentials.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Install and configure Print and Document Services

Manage network printers

This topic explains how to connect an on-premises deployment of Microsoft Dynamics 365 Finance +

Operations (on-premises) to existing network printer devices. Network printing in the on-premises application is

supported by the Print and Document Services feature in Microsoft Windows Server 2016. This feature lets you

centralize tasks that are related to printer management. To install and configure Print and Document Services,

you must have administrative access to the server that hosts the primary instance of Application Object Server

(AOS).

Two roles are associated with the configuration of network printing services:

Ser vice AdministratorSer vice Administrator  – The person who has this role is responsible for installing and configuring

components of the platform infrastructure. Traditionally, this role is an Active Directory account that has

elevated domain privileges. It has enough privileges to install components of Microsoft Windows Server.

Organization AdministratorOrganization Administrator  – The person who has this role manages application security privileges. This

Active Directory account is assigned to the System AdministratorSystem Administrator  role.

Before the organization administrator can begin to add network printers, the service administrator must install

and configure Print and Document Services on the server that hosts the primary AOS instance. The organization

administrator can then begin to use built-in tools to configure network printer devices.

The environment administrator uses the information in this section to enable network printing services.

1. Install Print and Document Services by following the instructions in Install Print and Document Services.

2. Configure Print and Document Services by following the instructions in Configure Print and Document

Services.

3. Follow these steps for each server that is used to host the AXService application:

a. On the local server, start the Local Users and GroupsLocal Users and Groups  manager.

b. Select the GroupsGroups  node.

c. Right-click Pr int OperatorsPr int Operators , and then select Add to GroupAdd to Group.

d. Add the network Active Directory account that is used to run the AXService application to the group.

e. Install network printers by using the AXService user account. This step helps guarantee that the printer

driver is available to the AXService user account.

f. Print a test page on the installed printers to make sure that all the connections are correctly

configured.

g. Restart the AXService application to help guarantee that the user's profile is correctly loaded so that it

can look up the printer driver.

The system administrator uses the information in this section to define network printers.

1. Go to Organization administrationOrganization administration > SetupSetup > Network pr intersNetwork pr inters .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/install-network-printer-onprem.md
https://technet.microsoft.com/library/hh831468(v=ws.11).aspx
https://technet.microsoft.com/library/jj134159(v=ws.11).aspx
https://technet.microsoft.com/library/jj134163(v=ws.11).aspx
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2. On the Network pr intersNetwork pr inters  page, add new printers. For each printer, specify a name, description, path, and

status. Make sure that the printer path matches the network path of the installed printer.

Items that are marked ActiveActive immediately become available to application users, so that they can begin to print

document-style reports on network printer devices.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Document publishing services: secure, reliable, and convenient

This topic describes the capabilities for generating, publishing, and printing documents in on-premises

deployments of Microsoft Dynamics 365 Finance + Operations (on-premises). The application provides a fully

integrated experience for enterprise document generation that is powered by Microsoft SQL Server Reporting

Services (SSRS). From any supported device, users can produce standard industry documents that are linked to

business processes. These documents include sales invoices, checks, and packing slips. Built-in tools let

administrators configure the service so that users can securely connect to network printers.

You can upgrade solutions that are built on the Microsoft Dynamics AX 2012 SQL Reporting Services

framework, or you can take advantage of the modern solutions that are available in Microsoft Dynamics

Lifecycle Services (LCS).

Employees spend lots of time on the go. Therefore, businesses depend on their employees' ability to stay

productive while they work remotely. However, even today, documents remain critical for business transactions

and record keeping.

From their mobile devices, users can print documents on network printers. Users can also automate the creation

of business documents and use built-in tools to configure instructions for routing documents to multiple

recipients.

The following options are available for document publishing:

EmailEmail  – Distribute mail via a server, and link reports as attachments.

ArchiveArchive – Store reports for future reference and regulatory compliance.

FileFile – Produce a PDF file that is downloaded directly to the browser for local printing.

Pr intPr int – Send documents directly to network printers from all supported platforms. These platforms include

mobile devices.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/printing-capabilities-on-premises.md
https://lcs.dynamics.com


Comparing the cloud-hosted and on-premises services

Managing access to network printers

Appendix
Turning on embedded links in business documentsTurning on embedded links in business documents

For a high-level summary of the options for information access that are available in the cloud-hosted solution,

see Document printing overview.

Unlike the cloud-hosted service, the on-premises publishing service produces documents as PDF files that are

automatically downloaded to the browser. Therefore, users can save documents or print hard copies by using

local connected devices. Administrators can manage access to network printers directly from the application, by

using built-in administrative pages. Users can interact with reports on demand, or they can schedule automatic

jobs to securely generate and distribute documents on a recurring basis.

The following illustration shows the components that are involved in document printing.

For information about how to use extensions to manage availability of the embedded drill-through links in

application reports, see the Appendix.

Administrators can use built-in administrative pages to manage access to network printers. Network printers are

secured per company and shared by users of the application. Documents are then printed by using a privileged

domain account, based on settings that the user provides. In on-premises deployments, you don't have to install

an adapter to connect to domain resources such as printers and fax machines.

The following illustration shows the page that is used to manage network printers.

Here is the code that you can use to make embedded drill-through links available in PDF documents.



class Controller extends SrsReportRunController
{
    protected void preRunModifyContract()
    {
        this.parmReportContract().parmRdlContract().parmEnableFileDrillThrough(true);
        super();
    }
    static void main(Args _args)
    {
        ...
    }
}

NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Service applications

Documents that require custom margins

Install the latest build

The Document Routing Agent includes an option that lets you select the mode of execution. The process can run

as either a desktop application or a Microsoft Windows service. When the application runs as a Windows

service, it can be started automatically after a computer restart. It can also be configured to run under the

security context of a specific user account. This enhancement lets customers host the Document Routing Agent

on secured domain resources such as network print servers.

This topic provides important information that will help you select the correct execution mode.

An application is a program that a user interacts with on the desktop. A service is a process that runs in the

background and doesn't have an active window. The Document Routing Agent now supports both execution

modes. It's important that you understand why you might select one mode instead of the other and the steps

that are involved in running the process as a service. For more information about Windows services, see

Introduction to Windows Service Applications. Here are some of the main benefits of running the Document

Routing Agent as a background service:

The service can be configured to start automatically after a computer restart. No user intervention is

required.

The service runs in the background. No active application runs in the notification area.

The service routes documents without requiring that a user sign in by using cached credentials.

Although there are many benefits of running the Document Routing Agent as a Windows service, there are also

limitations. The next section discusses an issue that affects the handling of document reports, such as checks,

that require custom page margins.

When the Document Routing Agent runs as a Windows service, document reports, such as checks, that require

custom margins can't be printed directly to network printers. Instead, the Document Routing Agent

automatically routes those document to a target folder. New configuration properties in the application's

SettingsSettings  dialog box let you define the target location for document reports that require custom margins.

When the Document Routing Agent runs as a desktop application, it continues to take advantage of Adobe

Reader to spool the document to the shared printer device that is selected in Finance and Operations. To handle

scenarios where documents that have custom margins must be printed, we recommend that you install the

Document Routing Agent in multiple locations. Then install the printers that will handle those documents only

on the Document Routing Agents that will run in desktop application mode. Alternatively, use a post-execution

process to pick up the files in the target directory and direct them in the appropriate manner.

1. Save a copy of the current Document Routing Agent configuration file. This file is located at C:\Users\

<UserID>\AppData\Local\Microsoft\Microsoft Dynamics 365 for Finance and Operations Document

Routing\Microsoft.Dynamics.AX.Framework.DocumentRouting.config. In this path, <UserID> is the Active

Directory Domain Services (AD DS) user name that the Document Routing Agent was installed under.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/run-document-routing-agent-as-windows-service.md
https://docs.microsoft.com/en-us/dotnet/framework/windows-services/introduction-to-windows-service-applications


Change the default execution mode

Update the execution mode for the Document Routing AgentUpdate the execution mode for the Document Routing Agent

Configure and start the Windows serviceConfigure and start the Windows service

NOTENOTE

2. Uninstall the current version of the Document Routing Agent.

3. Install the latest version of the Document Routing Agent by following the instructions in Install the

Document Routing Agent to enable network printing.

Although you install the application at this point, don't run it yet.

4. Copy the configuration file from step 1, and paste it into the following directory:

C:\ProgramData\Microsoft\Microsoft Dynamics 365 for Finance and Operations Document Routing. This

step helps guarantee that all your previous configuration settings are used for the new version of the

Document Routing Agent application.

5. Run the Document Routing Agent.

6. Sign in by using your Microsoft Azure Active Directory (Azure AD) or your credentials for your Finance

and Operations apps.

7. View and verify your settings and printers by clicking the appropriate menu items.

The next section provides detailed instructions for selecting the Windows service execution mode.

By default, the Document Routing Agent runs as a desktop application. To run the process as a Windows service,

make sure that you're familiar with the process for installing the Document Routing Agent to enable network

printer devices. Then complete the following tasks.

1. Start the Document Routing Agent by using the desktop icon.

2. Select the S ign InSign In option, and sign in by using your Azure AD credentials.

3. On the ribbon, select SettingsSettings .

4. Enable the Run as a Windows Ser viceRun as a Windows Ser vice option.

5. Provide a target folder for PDF files that are produced for documents that have custom margins.

6. Select OKOK, and close the Document Routing Agent window.

NOTENOTE

1. In Windows, start Service Manager.

2. In the list, select Microsoft Dynamics 365 for Finance and Operations Document RoutingMicrosoft Dynamics 365 for Finance and Operations Document Routing

Ser viceSer vice.

3. Right-click the name, and then select Proper tiesProper ties .

4. On the Log OnLog On tab, select the This accountThis account option, and then supply the AD DS credentials that are used

to run the service.

The selected account must have access to the shared network devices. The windows domain account ( or local

machine account) used to run the windows service must be same as the account that starts the Document

Routing Agent desktop app.

5. Select OKOK.



Troubleshooting tips
Verify the network printer connectionVerify the network printer connection

Verify security rolesVerify security roles

Review the service account's access rightsReview the service account's access rights

Refresh the Azure service tokenRefresh the Azure service token

Disable shared printers for remote accessDisable shared printers for remote access

Review the event logsReview the event logs
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6. Start the service.

The Document Routing Agent is now running as a Windows service.

Verify that the active account has enough access rights to the network printer.

Verify that the user account can successfully print to the network device by using Notepad or another local

application.

To access the application links that are used to install the Document Routing Agent, the user must be part of

the Document routing clientDocument routing client security role.

Verify that the DocumentRoutingSer viceDocumentRoutingSer vice service is running as a domain account that has access to the

network devices.

Azure authentication tokens must be refreshed ever y 90 daysrefreshed ever y 90 days  while the Document Routing Agent is

running as a Windows service. To refresh the service token, start the client, and then sign out and sign back

in by using the menu items.

When you connect to the host machine by using Microsoft Remote Desktop, make sure that you clear the

PrintersPr inters  option in the Local devices and resourcesLocal devices and resources  section on the Local ResourcesLocal Resources  tab.

1. On the host machine, start Event Viewer.

2. Review the logs at Application and Ser vices LogsApplication and Ser vices Logs  > MicrosoftMicrosoft > DynamicsDynamics  > AX-DocumentRoutingAX-DocumentRouting.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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To view the report
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This topic points you to a report that lists the SQL Server Reporting Services (SSRS) reports available.

Reports can be defined simply as any visualization of a structured data set. This may include transactional data

presented in a tabular layout and advanced graphical views of aggregate information. To account for this broad

definition, the application offers several tools to produce reports to satisfy complex business requirements. One

of these tools is SQL Server Reporting Services. SSRS reports provide the following advantages:

Back office document management capabilities including email support, scheduled executions via batches,

and print archive functionality.

Parameterized views with drill-through navigation to application pages and other reports.

Used to produce precision documents for compliance with local regulatory business practices.

For more information, see Create reporting solutions.

The SQL Ser ver Repor ting Ser vices Repor ts repor tSQL Ser ver Repor ting Ser vices Repor ts repor t, included with the Technical reference reports, lists

each SSRS report that is available. The report indicates the data set used for each report, as well as the filters

and fields available on each report.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Introduction

Why aren't these designs the default designs for the application suite
reports?

This topic explains how to install the modern report design templates in the application suite. You can use these

samples to create graphically rich business documents that have flexible branding in the header and footer.

A new set of developer tools is available that takes the form of report designs for several core business

documents in the application suite. These report designs have been re-imagined so that flexible branding

appears in the header and footer of public-facing documents when transactions are generated in the application.

The following illustration shows how an earlier design for a sales invoice differs from a modern sales invoice

design.

After you complete the installation, you can use the built-in brand management tools to define brand settings

that should be applied to the modern designs for application business documents. The brand management tools

are available at Organization administrationOrganization administration > SetupSetup > Document brandingDocument branding > Branding detailsBranding details .

We are maintaining the legacy solutions for two primary reasons:

Modern designs don't include code.Modern designs don't include code. Although the legacy solutions use embedded Microsoft Visual Basic

(VB) code to recognize configuration keys and honor regulatory requirements that vary by region, the

modern report designs offer much less flexibility. The benefit of a simple design that has minimal code

behind it comes at the expense of reusability across regions.

Modern designs aren't available for all business documents.Modern designs aren't available for all business documents. There is a gap between the supported

business documents and the availability of modern report designs. Although the legacy designs aren't as

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/install-modern-report-design-templates.md
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IMPORTANTIMPORTANT

Apply the modern designs

Build the application suite

aesthetically pleasing, they provide a sense of consistency.

The simple modern designs are notnot  recommended for all types of deployments. They are intended for cases where the

customer doesn't require runtime control over the layout of the document through existing application configuration

settings.

The modern report designs have been bundled into a model file and posted to Microsoft Dynamics Lifecycle

Services (LCS). Therefore, you can easily access them from your existing subscription. Use the following

procedure to obtain the modern report design solutions and install them in your local development

environment. You must then apply some customizations to incorporate the modern report designs into the

appropriate scenarios.

Follow these steps to install the modern report designs for the application suite.

NOTENOTE

ModelUtil.exe -import -metadatastorepath=[path of the metadata store] -file=[full path of the file to 
import]

ModelUtil.exe -import -metadatastorepath=J:\AOSService\PackagesLocalDirectory -
file="E:\Test\AppSuiteModernDesigns.axmodel"

1. Sign in to LCS to access the deployment dashboard. Then, on the Shared asset librar yShared asset librar y  page, select the

ModelModel  asset type, and download the ApplicationSuiteModernDesignsApplicationSuiteModernDesigns  model file. Save the model file

to a location that is accessible from the development environment.

Be sure to select the appropriate model file for the version of the application that you're using.

2. Import the model file into your local development environment. To install a model file in a development

environment, use the ModelUtil.exe tool and the -impor t-impor t directive. Here is an example.

3. Navigate to the J :\AOSSer vice\PackagesLocalDirector y\binJ:\AOSSer vice\PackagesLocalDirector y\bin folder.

4. Run the following command.

For more information about how to import model files, see Export and import models. After you've

imported the model file, start Microsoft Visual Studio. In Application Explorer, verify that the ApplicationApplication

Suite - Modern DesignsSuite - Modern Designs  collection appears under the AOTAOT node. For more information about how to

use the Application Explorer, see Development tools tutorial

Now that you've successfully imported the Application Suite Modern Designs model, you must to rebuild the

application suite to update the metadata elements.

The Application Suite Modern Designs model is an extension of the Application Suite model. To help guarantee

that all application references are updated so that they target the model extensions, you must build the

Application Suite model by using Microsoft Visual Studio.

1. Start Visual Studio, or use the existing instance.

https://lcs.dynamics.com/
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-tools/models-export-import
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-tools/introduction-visual-studio


Deploy the modern designs (one-box environments)

NOTENOTE

2. On the Dynamics 365Dynamics 365  menu, select Build modelsBuild models .

3. In the list, select the check box for the ApplicationSuiteApplicationSuite package.

You will see that the Application Suite Modern Designs model is included in the package definition.

4. Select BuildBuild to do a full build of the application suite.

This process may take up to 20 minutes, depending on the size of your machine.

After you've compiled the application suite that includes the modern report design templates, you should verify

the changes locally. To verify the changes, you must deploy the new modern report design solutions to the

instance of Microsoft SQL Server Reporting Services (SSRS) that is running locally.

Follow these steps to incorporate the modern report design into an existing application suite report.

1. Create a project that contains the application suite report. In Application Explorer, under the ApplicationApplication

Suite Modern DesignsSuite Modern Designs  model, expand the Repor tsRepor ts  node, and then expand the Repor tsRepor ts  subnode. Select all

the items in the folder, right-click, and then select Add to new projectAdd to new project.

2. Complete the New ProjectNew Project wizard. Accept all default values.

3. In Solution Explorer, select the project, right-click, and then select Deploy repor tsDeploy repor ts  to deploy the build and

deploy the reports locally.

When you add the modern report design to an existing report, you can reuse both the parameter handling and

the data provider that the out-of-box solution uses.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/buildappsuite.png


Update Print management settings

NOTENOTE

At this point, you should be able to access the modern report designs from the application. Make sure that you

do thorough test validations on the modern report design templates before you deploy them to production

environments. To do test validations, you must activate the modern report designs for the application business

process.

Follow these steps to update the Print management settings for customer sales orders by selecting the modern

report design solution as the default report design.

1. Open the Form setupForm setup page for the module. For example, for Accounts receivable, select AccountsAccounts

receivablereceivable > SetupSetup > FormsForms > Form SetupForm Setup.

2. Select Pr int managementPrint management to open the Pr int management setupPrint management setup page.

3. Expand the tree, and find the settings for the Sales order confirmationSales order confirmation document.

4. Select Original <Default>Original <Default> to begin to modify the default document routing.

5. In the Repor t formatRepor t format list, select SalesConfirmModern.Repor tSalesConfirmModern.Repor t to enable the modern report design

solution.

6. Open another page. This step forces a save operation to occur.

7. Post a sales order to view the modern design in the application.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/updateprintmgtsettings.png
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Power BI DirectQuery mode

Stage aggregate measurements in Entity store

Entity store is an operational data store that is included with Microsoft Dynamics 365 Finance. This topic

describes how Entity store enables Power BI integration.

Entity store is an operational data store that is included with the application. The Entity store feature was

introduced in the Microsoft Dynamics AX platform update 1 (May 2016) release. This feature lets an

administrator or power user stage aggregate measurements in a dedicated data store for reporting and

analytics. (Aggregate measurements are a star schema that is modeled by using entities.) We call this data store

Entity store. It’s a database that is optimized for reporting purposes. Entity store uses the in-memory, clustered

columnstore index (CCI) functionality that is built into Microsoft SQL Server to optimize reporting and queries.

Customers can use Microsoft Power BI DirectQuery models together with Entity store to enable high-volume,

near-real-time analytical reporting over large volumes of data.

In the February 2016 release of Microsoft Dynamics AX, you could create Power BI reports by using OData

endpoints that are exposed via data entities (both aggregate data entities and detailed or regular data entities).

Although this approach is still supported, Entity store also lets power users create Power BI DirectQuery reports.

As the preceding illustration shows, DirectQuery is a reporting mode that runs reports directly on Entity store. In

this reporting mode, data isn't staged in Power BI caches. This mode provides two immediate benefits:

You can create Power BI reports over large data volumes.

Reports don't have to be updated by using Power BI. When Entity store is updated, reports reflect the latest

data.

Additionally, data doesn't leave your environment, because no data is cached in the Power BI service.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/power-bi-integration-entity-store.md
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/entity-store-architecture.jpg


Aggregate measurements are a star schema that is modeled for analytical scenarios. In the February 2016

release, we enabled real-time, in-memory aggregate measurements. By using real-time aggregate

measurements, you can enable embedded charts and key performance indicators (KPIs) that react to real-time

operations on data. For information, see Transition from Analysis Services cubes to aggregate models. Real-time

aggregate measurements take advantage of the in-memory, non-clustered columnstore index (NCCI)

technology. Visuals and aggregate calculations that are built over real-time aggregate measurements reflect

transactions within seconds. In the platform update 1 (May 2016) release, we enabled aggregate measurements

that can be staged in Entity store. Aggregate measurements that are staged in Entity store can be used for near-

real-time analytical scenarios where large volumes of data must be explored by using Power BI. As a developer,

you learned how to model an aggregate measurement for real-time analytics in Model aggregate data. In the

platform update 1 (May 2016) release, we also added the capability to model aggregate measurements that can

be staged in Entity store. In Microsoft Visual Studio, you can specify StagedEntityStoreStagedEntityStore as the usage property

of an aggregate measurement. This new property was added in May 2016. Previously, InMemor yRealTimeInMemor yRealTime

was available as the usage property.

However, you might wonder why you would model an aggregate measurement so that it can be staged? Why

wouldn’t you use in-memory real-time aggregate measurements all the time? There are several reasons for

using the StagedEntityStoreStagedEntityStore pattern:

There might be large amounts of data that must be explored and analyzed.

You might have Analysis projects (that is, cubes) that you migrated from Microsoft Dynamics AX 2012 R3 as

part of the code upgrade process. Because of the complex views and joins that are present in the schema,

query response times might not be acceptable for embedded visuals. However, you might not want to

refactor the visuals to take advantage of NCCI technology immediately.

Unlike the operational database schema, the schema in Entity store is modeled specifically for reporting.

Therefore, it's much easier to build new reports from the schema in Entity store.

Your scenario might not require that analytical data be updated within seconds of an operation. Most Power

BI reports that are built to enable data exploration fall into this category. If data freshness of approximately

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/migration-upgrade/in-memory-real-time-aggregate-models


  Update Entity store

Connecting to the Entity store databaseConnecting to the Entity store database

NOTENOTE

10 minutes is acceptable for your scenario, you might want to use the staged pattern.

If one of the preceding reasons covers your situation, you should stage your aggregate measurement in Entity

store and it use for Power BI integration.

Entity store refresh is automated and managed by the system. In the client, you can find the Entity StoreEntity Store page

at Systems administrationSystems administration > SetupSetup > Entity StoreEntity Store. For more information, see Automated Entity store

refresh.

For troubleshooting and diagnostics, you can connect to the Entity store database directly from a related

sandbox environment. To connect:

1. Use Remote Desktop to access the sandbox. The RDP file can be downloaded from the EnvironmentEnvironment

DetailsDetails  page after you have included your IP address in a safe list.

2. Open SQL Server Management Studio, and connect to the server specified on the Environment DetailsEnvironment Details

page.

3. Using the OptionsOptions  button or by browsing to the Connection Proper tiesConnection Proper ties  tab, change the Connect toConnect to

databasedatabase property from the default value to your Database NameDatabase Name value from LCS.

4. Click ConnectConnect to access the database.

Find the section titled Database AccountsDatabase Accounts . Locate the entry for the user with the name axdwadminaxdwadmin.

The server name is the first portion of the SQL Ser ver\Database NameSQL Ser ver\Database Name field. This should be used in

the format of SQLSer verName.database.windows.netSQLSer verName.database.windows.net where SQLServerName is the value from

LCS.

The authentication type should be changed from Windows Authentication to SQL Server

Authentication.

The login will be axdwadmin and the password will be the value from LCS.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/automated-entity-store-refresh
https://aka.ms/BAG_Docs_Language_Survey
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NOTENOTE

If you are using application analytical workspaces

When maintenance is performed on the entity store, it impacts the following components:

Application analytical workspaces.

Entity store-based reports that have been deployed to PowerBI.com.

To resolve issues with these components, complete the procedures in this topic.

There will be no impactno impact  to the normal operation of your application.

Application analytical workspaces and reports may not render data after certain maintenance operations are

completed. The following screenshot shows an example of this.

To resolve this issue:

1. Sign in to the application.

2. Go to the Batch jobsBatch jobs  page (System administration > Inquir ies > Batch jobsSystem administration > Inquir ies > Batch jobs ).

3. Delete all pending batch jobs associated with the entity store. These batch jobs:

Will have a status of WaitingWaiting.

Will typically have a description of Deploy measurementDeploy measurement.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/entity-store-maintenance.md


If you have deployed entity store-based reports to PowerBI.com and
are using the reports within PowerBI.com

NOTENOTE

NOTENOTE

NOTENOTE
The default description is Deploy measurementDeploy measurement . If the description has been customized, you can verify whether

a batch job is associated with the entity store by looking at the class name. Batch jobs associated with the entity

store will have a class name of BIMeasurementDeployManagementEntityBatchJobBIMeasurementDeployManagementEntityBatchJob.

4. Go to the Entity storeEntity store page (System Administration > Setup > Entity StoreSystem Administration > Setup > Entity Store).

5. Select all measurements that need to be refreshed.

6. Click RefreshRefresh, and then click OKOK.

After the refresh completes, the application analytical workspaces and reports will render data.

After refreshing the entity store (as described above), redeploy the reports using the Deploy Power BI repor tDeploy Power BI repor t

filesfiles  page by selecting System AdministrationSystem Administration > SetupSetup > Deploy Power BI filesDeploy Power BI files .

Reports that were previously deployed to PowerBI.com may produce errors. If this occurs, you may need to delete and

redeploy the report after the maintenance activity is completed.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Configure PowerBI.com integration
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Overview

Things you must know before you start

Registration process

NOTENOTE

Users can pin tiles, dashboards, and reports from their own PowerBI.com account to application workspace.

This functionality requires a one-time configuration of your environment. An administrator must do this step to

enable Microsoft Power BI to communicate and authenticate correctly.

For a workspace to show a Power BI tile, the server must contact the Power BI service on behalf of a user and

access the visualization. It must then redraw the visualization in the application workspace. The fact that the

server contacts the Power BI service "on behalf of a user" is important. When a user, such as 

D365User@contoso.com , contacts the PowerBI.com service, Power BI should show only tiles and reports from the

user's PowerBI.com subscription.

By completing this configuration step, you enable to contact the PowerBI.com service.

You must be a system administrator in the application. This option is available on the SystemSystem

administrationadministration menu.

You must have a PowerBI.com account. You can create a trial account if you don't have an account. (A Pro

license isn't required for this configuration step.)

You must have at least one dashboard and one report in your Power BI account. Although the dashboard and

report aren't required for this configuration step, you might not be able to validate the configuration if you

don't have any content in your PowerBI.com account.

You must be an administrator for your Microsoft Azure Active Directory (Azure AD) account. If you aren't the

administrator, an administrative user must perform this configuration step for you.

The Azure AD domain that is configured must be the same domain that you used for your PowerBI.com

account. For example, if you provisioned the application in the Contoso.com domain, you must have Power BI

accounts in that domain, such as Tim@ContosoAX7.onmicrosoft.com .

Users navigating to these pinned tiles must have a valid Power BI.com license.

1. Sign in to https://portal.azure.com/ using an Azure tenant admin account.

The user who completes this procedure must have Admin rights for the tenant to register applications.

2. Go to Azure Active Director yAzure Active Director y  > App registrationsApp registrations  > New application registrationNew application registration.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/configure-power-bi-integration.md
https://portal.azure.com/


NOTENOTE

3. Enter the following values:

NameName - Your app name.

Application typeApplication type - Web app/API

S ign-on URLSign-on URL  - The base URL of your client. For example, https://contosoax7.cloud.dynamics.com .

Depending on your version, you may need to add /oauth as a suffix to the URL, or use http instead of https as the

protocol, such as: https://contosoax7.cloud.dynamics.com/oauth  or 

http://contosoax7.cloud.dynamics.com/oauth .

4. Click CreateCreate.

5. Copy the Application IDApplication ID. This will be used to connect to the PowerBI.com service.

6. Click SettingsSettings  > Required permissionsRequired permissions  > AddAdd > Select an APISelect an API > Power BI Ser vice (Power BI)Power BI Ser vice (Power BI) .

7. Click SelectSelect.

8. Enable Access and click SelectSelect.



Specify Power BI settings in Finance and Operations

9. Click DoneDone and then click Grant PermissionsGrant Permissions .

10. Click SettingsSettings  > KeysKeys .

11. Enter a value for Key descr iptionKey descr iption and ExpiresExpires , and then click SaveSave.

Make a note of the Application IDApplication ID and Application KeyApplication Key . You will use these values in the next procedure.

1. In the client, open the Power BI configurationPower BI configuration page.



Pin tiles to a workspace

2. Select EditEdit.

3. Set the EnabledEnabled option to YesYes .

4. In the Application IDApplication ID field, enter the Application IDApplication ID value that you got from Power BI in the previous

procedure.

5. In the Application KeyApplication Key  field, enter the Application KeyApplication Key  value that you got from Power BI in the

previous procedure.

You can apply the company filter only if your Power BI content has a table that is named CompanyCompany  and a

column that is named IDID. Ready-made Power BI content that is released uses this convention.

6. Click SaveSave.

Complete the steps in the next section to verify the changes and enable PowerBI.com integrations.

1. To validate the PowerBI.com configuration, click Get star tedGet star ted.



NOTENOTE
You may need to refresh the browser to apply the changes. 

If you're starting Power BI from the application for the first time, you're prompted to authorize sign-in to Power

BI from the client. Select Click here to provide authorization to Power BIClick here to provide authorization to Power BI.

Users must complete this step the first time they pin Power BI content.

2. The Azure AD consent page asks for your consent. User consent is required for the application to access

PowerBI.com on behalf of the user. Select AcceptAccept.

3. Because you're already signed in to Azure AD, you don't have to enter your credentials again. A new tab

appears, where you're prompted to authorize the connection between the application and Power BI.

Authorize the connection, and then return to the original tab.

4. A list of tiles from your PowerBI.com account appears. Select one or more tiles to pin to the selected

workspace. 



Troubleshooting common errors

Some common issues and the resolution stepsSome common issues and the resolution steps

ERRO RERRO R RESO L UT IO NRESO L UT IO N

The Power BI service is unavailable. This issue doesn't occur very often, but the Power BI service
might sometimes be unreachable. You don't have to re-
register. Try to pin a tile to a workspace later.

You can't access the application. You probably didn't select all the check boxes under Step 8Step 8
in the Registration processin the Registration process during the registration
process. Start Power BI, and re-run the registration process.

The Power BI tiles page is empty (no content is shown). Your PowerBI.com account might not have a dashboard or
any tiles. Add a dashboard, such as a sample dashboard, and
try to pin a tile again.

Error when authorizing Power BI On the Azure Admin dashboard, under Users and GroupsUsers and Groups
> User settings> User settings , make sure that the Users can consentUsers can consent
to apps accessing company data on their behalfto apps accessing company data on their behalf
option is set to YesYes .

Sorry, something went wrong. The authentication process
was not successful. Please contact your system administrator.

This may occur in cases where service keys have expired. We
recommend performing the registration process above,
starting with step 3. When complete, be sure to update the
PowerBI.com settings at AX client > SystemAX client > System
administration > Set up > PowerBI.com integrationadministration > Set up > PowerBI.com integration.

In the procedure above, after you click AcceptAccept, you might receive the following error message if the process is

unsuccessful. Note that the details of the error appear at the bottom of the message. Additional technical

information provides clues that can help you determine what went wrong.



NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Entity store or BYOD?

NOTENOTE

Creating a SQL database

This topic explains how administrators can export data entities from the application into their own Microsoft

Azure SQL database. This feature is also known as bring your own database (BYOD). The BYOD feature was

released in Microsoft Dynamics AX with platform update 2 (August 2016). Minor improvements and bug fixes

have been included in subsequent platform updates.

The BYOD feature lets administrators configure their own database, and then export one or more data entities

that are available in the application into the database. (Currently, more than 1,700 data entities are available.)

Specifically, this feature lets you complete these tasks:

Define one or more SQL databases that you can export entity data into.

Export either all the records (full push) or only the records that have changed or been deleted (incremental

push).

Use the rich scheduling capabilities of the batch framework to enable periodic exports.

Access the entity database by using Transact-SQL (T-SQL), and even extend the database by adding more

tables.

If you followed the series of blog posts about Microsoft Power BI integration, you will be familiar with Entity

store. Entity store is the operational data warehouse. Entity store provides built-in integration of operational

reports with Power BI. Ready-made reports and analytical workspaces use Entity store. If you write Power BI

reports by using data in your application environment, you should use Entity store.

However, the BYOD feature is recommended for the following scenarios:

You must export data into your own data warehouse.

You use analytical tools other than Power BI, and those tools require T-SQL access to data.

You must perform batch integration with other systems.

The application doesn't allow T-SQL connections to the production database. If you're upgrading from a previous version

of Finance and Operations, and you have integration solutions that require direct T-SQL access to the database, BYOD is

the recommended upgrade path.

You can use either Entity store or BYOD. The default operational reports that are available take advantage of

embedded Power BI and Entity store. We recommend that you use our default operational reports as your first

choice. You can also extend the ready-made operational reports to meet your requirements. You should consider

BYOD a complementary option that you use as you require.

Before you can configure the entity export option and use the BYOD feature, you must create a SQL database by

using Azure portal.

For one-box development environments, you can create a database in the local Microsoft SQL Server database.

However, this database should be used only for development and testing purposes. For production

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/export-entities-to-your-own-database.md
https://blogs.msdn.microsoft.com/dynamicsaxbi/2016/06/09/power-bi-integration-with-entity-store-in-dynamics-ax-7-may-update/
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Configuring the entity export option

NOTENOTE

environments, you must create an Azure SQL database.

You should also create a SQL user account for sign-in to the database. Write down the server name, database

name, and the SQL user ID and password. You will use this information when you configure the entity export

option in the next section.

If you're using the BYOD feature for integration with a business intelligence (BI) tool, you should consider using

clustered columnstore indexes (CCIs). CCIs are in-memory indexes that improve the performance of read

queries that are typical in analytical and reporting workloads.

Your BYOD database must be accessible to Finance and Operations apps. If you encounter issues where you are unable

access to access BYOD, you must ensure firewall rules in your BYOD are configured appropriately.

1. Start the client, and then, in the Data managementData management workspace, select the Configure Entity expor t toConfigure Entity expor t to

databasedatabase tile.

2. If you've configured any databases, a list is shown. Otherwise, you must configure a new database. In this

case, select NewNew , and then enter a unique name and a description for the new database. Note that you

can export entities into multiple databases.

3. Enter the connection string in the following format:

Data Source=<logical server name>,1433; Initial Catalog=<your DB name>; Integrated Security=False;

User ID=<SQL user ID>; Password=<password>

In this connection string, the logical server name should resemble nnnn.database.windows.netnnnn.database.windows.net. You

should be able to find the logical server name in Azure portal. The following illustration shows an

example of a connection string.

The default extension field shown in the image above does not apply to BYOD.

4. Select ValidateValidate, and make sure that the connection is successful.



Publishing the entity schema to the databasePublishing the entity schema to the database

PublishPublish

Drop entityDrop entity

Compare source namesCompare source names

The Create clustered column store indexesCreate clustered column store indexes  option optimizes the destination database for selected

queries by defining CCIs for entities that are copied. However, CCIs are currently supported only on

SQL premium databases. Therefore, to enable this option, you must create a SQL premium database.

The Enable tr iggers in target databaseEnable tr iggers in target database option sets export jobs to enable SQL triggers in the target

database. This option lets you hook downstream processes into the trigger to orchestrate actions that

must be started after records have been inserted. One trigger is supported per bulk insert operation.

The size of the bulk insert is determined by the Maximum inser t commit sizeMaximum inser t commit size parameter in the

Data management framework.

For scenarios in which reporting systems read data from BYOD, there is always the challenge of ensuring that

the reporting systems get consistent data from BYOD while the sync is in progress. You can achieve this result

by not having the reporting systems read directly from the staging tables created by the BYOD process. The

staging tables hold the data while data is being synced from the instance and hence will be constantly changing.

Use the SQL trigger feature to determine when the data sync has been completed, and then hydrate the

downstream reporting systems.

When the validation is passed, the database that you configured for entity export appears in lists of databases,

as shown in the following illustration.

You can now publish one or more entities to the new database by selecting the PublishPublish option on the menu.

The PublishPublish page enables several scenarios:

Publish new entities to the database.

Delete previously published entities from the database. (For example, you might want to re-create the

schema.)

Compare published entities with the entity schema. (For example, if new fields are added later, you can

compare the fields with your database schema.)

Configure change tracking functionality that enables incremental updates of your data.

The following sections discuss each option.

The PublishPublish option defines the entity database schema on the destination database. When you select one or

more entities, and then select the PublishPublish option, a batch job is started. This job creates the entities in the

destination database. When the database definition job is completed, you receive a message, which you can

access by using the bell symbol in the upper right.

The actual data update occurs when you export data. At this point, you're just creating the schema.

The Drop entityDrop entity  option deletes the data and the entity definition from the destination database.

The Compare source namesCompare source names  option lets you compare the entity schema in the destination with the entity

schema in the application. This option is used for version management. You can also use this option to remove

any unwanted columns from the destination table.



Configure change trackingConfigure change tracking

O P T IO NO P T IO N DESC RIP T IO NDESC RIP T IO N

Enable primary table An entity consists of several tables. Select this option to
track all changes that are made to the primary table of the
entity. When changes are made to the primary table, the
corresponding record is inserted into or updated in the
destination database. Although data from the whole entity is
written to the destination table, the system triggers the
insert or update option only when the primary table is
modified.

Enable entire entity Select this option to track all changes to the entity. (These
changes include changes to all the tables that make up the
entity.) When changes are made to the entity, corresponding
updates are made to the destination.

Enable custom query This option lets a developer provide a custom query that the
system runs to evaluate changes. This option is useful when
you have a complex requirement to track changes from only
a selected set of fields. You can also select this option when
the entities that will be exported were built by using a
hierarchy of nested views. For more information, see Enable
change tracking for entities.

Change tracking is a feature that is provided in SQL Server and SQL Database. Change tracking enables the

database to track changes including deletes that are made on tables. The system uses change tracking to identify

changes that are made to tables as transactions. However, because the application must track changes at the

data entity level, there is additional logic on top of SQL change tracking to make this functionality work. The

steps to enable change tracking are explained later in this section.

The Change trackingChange tracking option on the PublishPublish page lets you configure how changes are tracked on the

underlying entity.

The following table describes the change tracking options that are available.

To use change tracking, you must enable the Change trackingChange tracking option as shown above in data management.

This action is available on the Data entitiesData entities  list page, by going to Data management > Data entitiesData management > Data entities . You

need to select an entity and select from one of the options listed above to enable change tracking on the data

entity.

If you republish an entity that exists in the destination database, the system warns you that existing data will be

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/entity-change-track
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Exporting data into your database

deleted because of the new operation.

When you confirm the publish operation, the system publishes the schema to the database, and you're notified

when the operation is completed.

By selecting the Show published onlyShow published only  option on the PublishPublish page, you can show only the entities that were

published to a given destination database. The Publish function creates the entity schema in the database. You

can navigate to the database and see the table schemas that were created, together with corresponding indexes.

Currently, you can't use BYOD to export composite entities into a database. You must export each entity in the composite

entity.

After entities are published to the destination database, you can use the Export function in the DataData

managementmanagement workspace to move data. The Export function lets you define a Data movement job that contains

one or more entities.

You can use the Expor tExpor t page to export data into many target data formats, such as a comma-separated values

(CSV) file. This page also supports SQL databases as another destination.

You can create a data project that has multiple entities. You can schedule this data project to run by using the

batch framework. You also schedule the data export job to run on a periodic basis by selecting the Expor t inExpor t in

batchbatch option.

The same job can also be used to export data from all companies. In prior to Platform update 27, this feature can

be enabled by enabling the flight DMFEnableAllCompanyExport as explained in Data management overview.

Starting in Platform update 27, this feature can be enabled in data management framework parameters. After

the feature is enabled, a new option will appear when adding an entity to a data project. This option can be

enabled to export data from all companies for the specific entity.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/data-entities-data-packages
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Incremental exportIncremental export

NOTENOTE

TimeoutsTimeouts

Known limitationsKnown limitations

There should be no active locks on your database during synchronizationThere should be no active locks on your database during synchronization

You can't export composite entities into your own databaseYou can't export composite entities into your own database

Entities that don't have unique keys can't be exported by using incremental pushEntities that don't have unique keys can't be exported by using incremental push

Adding multiple entities to an export project for BYOD must be done carefully to ensure the overall reliability of the BYOD

export is not compromised. Different parameters must be taken into consideration when deciding the number of entities

that are added to the same project. Some of these parameters should be the degree of complexity of the entities, data

volume per entity that is expected, and the overall time for export to complete at the job level. Adding hundreds of

entities must be avoided, therefore creating multiple jobs with smaller number of entities is recommended.

Use of recurring exports in Manage > Manage recurring data jobsManage > Manage recurring data jobs for BYOD is discouraged. You must use the

Expor t in batchExpor t in batch option.

When you add an entity for data export, you can select to do an incremental export (which is also known as

incremental push) or a full push. For incremental push to work, you must enable the Change trackingChange tracking option

in the database and specify an appropriate change tracking option, as described earlier in this topic.

A full push deletes all existing records from an entity and then inserts the current set of records from the selected entity.

If you select an incremental push, the first push is always going to be a full push. This is because SQL needs to

know which records have been 'tracked' in order to be able to track subsequent changes. Whenever a new

record is inserted, or a record is added or deleted, the corresponding change will be reflected in the destination

entity.

Because the first push is always a full push, we do not recommend that you do an explicit full push before you

enable change tracking.

We recommend that you first enable change tracking and schedule a export job with incremental push. This will

take care of the first full push and the subsequent incremental exports.

The default timeouts for BYOD exports are set to ten minutes for truncation operations and one hour for actual

bulk insert operations. When volumes are high, these timeout settings may not be sufficient and must be

updated. Starting with the release of Platform update 18, you can update the timeout settings by navigating to

Data managementData management > Framework parametersFramework parameters  > Br ing your own databaseBring your own database. These timeouts are company

specific and must be set separately for each company.

The BYOD feature has the following limitations.

Because BYOD is your own database, you must ensure that there are no active locks on your Azure SQL

database when data is being synced. Having active locks on your database during synchronization can result in

slow writes or even failure to export to your Azure SQL database.

Currently, composite entities aren't supported. You must export individual entities that make up the composite

entity. However, you can export both the entities in the same data project.

You might face this limitation especially when you try to incrementally export records from a few ready-made

entities. Because these entities were designed to enable the import of data, they don't have a unique key.

However, you can enable change tracking only for entities that have a unique key. Therefore, there is a limitation

on incremental push. One workaround is to extend the required entity and define a unique key.



Troubleshooting
Incremental push not working correctlyIncremental push not working correctly

SSIS Error Code DTS_E_OLEDBERROR. SSIS Error Code DTS_E_OLEDBERROR. An OLE DB error has occurred. Error code: 0x80004005An OLE DB error has occurred. Error code: 0x80004005

An OLE DB error has occurred. Error code: 0x80004005.

An OLE DB record is available. Source: "Microsoft SQL Server Native Client 11.0"  Hresult: 0x80004005  
Description: "Communication link failure".

An OLE DB record is available. Source: "Microsoft SQL Server Native Client 11.0"  Hresult: 0x80004005  
Description: "TCP Provider: An existing connection was forcibly closed by the remote host.

Failed to open a fastload rowset for <entityStaging>. Check that the object exists in the database.

OLE DB Destination failed the pre-execute phase and returned error code 0xC0202040.

NOTENOTE

IssueIssue - When a full push occurs for some entity then a large set of records can be seen in BYOD using a select

statement. However, an incremental push results in only a few records in BYOD. It seems as if the incremental

push deleted all the records and added only the changed records in BYOD.

SolutionSolution - In cases like this it is recommended to disable and re-enable change tracking for the entity in

question. The state of the SQL change tracking tables might not be in the expected state. Also verify that there

are no other incremental exports that cover the same tables (DMF, MR, Retail).

IssueIssue - Export to BYOD fails with an SSIS exception shown below.

SolutionSolution - This can occur if the connection policy on the Azure SQL BYOD server is set to Proxy. This must be

changed to 'Redirect' as explained in SQL DB Connectivity Architecture

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/azure/sql-database/sql-database-connectivity-architecture
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Accessing the PDF preview experience (Platform update 36 or later)

Additional feature information

Streamline application experiences that result in the production of business documents by taking advantage of

the embedded PDF Preview option. Finance and Operations applications deliver a modern experience to preview

business documents that are produced by the service. You can use the built-in toolbar to navigate and download

the document or to print to locally connected devices.

The embedded viewer offers consistency between the screen presentation and the printed output. In addition,

report viewing times are drastically reduced when compared to the legacy experience. The Preview option is

available on all supported devices and does not require any additional third-party software. Documents can be

easily downloaded and navigated by using the built-in viewer toolbar options.

The following illustration shows a preview of the experience with a modern business document. 

The legacy HTML-based preview experience is being replaced by a true document preview experience. There are

several key advantages in the modern PDF preview experience. These advantages include:

A fidelity between the screen presentation and the printed output.

A consistent document report preview experience across devices and platforms, including on-premises

deployments.

The server-side rendering improves the performance when producing the document.

A built-in tooling that allows users to quickly navigate the contents of the business document.

The PDF preview experience is enabled by default in Self-Service deployments and in environments hosted on

Platform update 39 or later. To use the PDF preview experience in cloud-hosted and Microsoft-managed

environments running Platform updates 36 thru 38, use Feature Management to enable the Repor t PDFRepor t PDF

viewerviewer  feature.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/preview-pdf-documents.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/infrastructure-stack


Feature limitations

NOTENOTE

Expandable/collapsible sections are available by default. These interactive operations do not function after

the PDF document has been created.

The printer drop-down menu allows users to choose from locally connected devices. This list does not

include network printers connected through the service.

Documents are downloaded to the local device using the built-in toolbar actions.

Use the Pr int destinationPrint destination options to produce documents in formats other than PDF.

The Embedded PDF viewer experience delivers a closed document that exactly matches the printed output of the

document. These documents cannot be modified by the recipient making the format ideal for business

operations. However, as a closed format, the documents are far less interactive on the screen when compared to

HTML presentations. The following end-user capabilities are not supported when previewing documents using

the embedded PDF viewer.

By default, embedded drill-thru navigation links are only available while previewing PDF documents.

PDF documents do not support expandable and collapsible sections.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Analytics, aggregate measurements, and KPI
modeling
2/18/2021 • 6 minutes to read • Edit Online

Embedded business intelligence

Where are the perspectives?

VERSIO NVERSIO N DESC RIP T IO NDESC RIP T IO N

Microsoft Dynamics AX 4.0 Perspectives provided the ability to model ad-hoc reporting
models.

Microsoft Dynamics AX 2009 Perspectives added support for modeling analysis cubes.

Microsoft Dynamics AX 2012 Perspective modeling capabilities were improved through
richer modeling support and deeper integration with the
Application Object Tree (AOT).

Finance and Operations apps Perspectives are a first-class citizen in the data access
framework. They can be consumed via X++ or C# code, and
also in a model-driven way.

This topic discusses the embedded business intelligence (BI), aggregate measurements, dimensions, and data

entities, and aggregate programming model.

The term embedded business intelligence (BI) refers to experiences that use highly intuitive and fluid

visualizations to provide insights that are relevant to a task, so that user is more informed and can make better

choices. For example, a rental clerk in a car rental organization views the previous rental preferences of a

customer when the customer makes a reservation. In this case, the clerk can see the vehicles and colors that the

customer has selected in the past, and therefore can offer options that are likely to please the customer.

Embedded BI is used throughout the user interface. At a technical level, building rich visualizations requires a

powerful charting framework, and also an efficient way to access aggregated data that enables the display of

fluid visualizations. Microsoft Dynamics 365 Finance and Operations meets both of these requirements, so that

application developers can build rich and deep embedded BI–enabled scenarios.

Perspectives were a concept that was designed to present data from a reporting point of view. Perspectives have

evolved over the past three releases for analytical scenarios.

Perspectives reside within the analytics collection in the Application Explorer. Perspectives have undergone a

major upgrade and now incorporate the following improvements:

You can model new aggregate models and customize existing aggregate models as a star schema within

Application Explorer.

Modeling for key performance indicators (KPIs) in Application Explorer is supported.

You can model data entities by referencing aggregate models. Data entities can be exposed to external

reporting tools, such as PowerBI, as OData endpoints. Data entities can also be consumed.

You can consume aggregate models directly in the programming model by using X++ or C# code. You no

longer have to write MDX code to consume aggregate data.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/analytics.md


Aggregate measurements and aggregate dimensions

Aggregate data entities

Aggregate programming model

Method expressions

Aggregate data is a first-class citizen within application data access. Its behavior is similar to the behavior of

detailed data. For example, aggregate data can be enriched with extended data types (EDTs) and

enumerations, and you can help secure them by using application security concepts.

The aggregate data infrastructure is maintained completely within the environment. By default, aggregate

measurements are real-time. As a system administrator, you can manage the latency of aggregate data and

controls based on available resources and business needs, without having to deal with the complexity of

scheduling and external tools.

Developers can reuse existing business models, making the modeling process quicker and easier.

Projects that were generated by using perspectives from Dynamics AX 2012 and later can be upgraded to

Finance and Operations metadata equivalents.

An aggregate measurement is a model that contains a collection of measures together with their corresponding

dimensions. Measures are aggregate numbers, such as Total Sales or Number of Orders. Dimensions are slicers,

such as Product, Vendor, or Customer, that help you analyze the measure. For example, the measure of Total

Sales isn't useful unless it can be sliced by Product, Region, and Customer. Aggregate measurements are the

evolution of AX 2012 analysis cubes. Whereas a cube was based on a multidimensional online analytical

processing (OLAP) technology, an aggregate measurement abstracts the underlying technology. Therefore, you

no longer have to know a lot about the underlying implementation technology. Additionally, the underlying

technology infrastructure can take advantage of improvements in in-memory real-time technology without

requiring the developer to rewrite the program. Aggregate dimensions are shared across an implementation.

Aggregate measurements associate themselves with relevant aggregate dimensions. For example, Total Sales

can be associated with Customer, Product, and Sales Region dimensions. However, Total Sales can't be associated

with Vendor and Warehouse dimensions. Aggregate dimensions and aggregate measurements are modeled by

using Visual Studio tools. The Upgrade tool lets customers and partners migrate existing Dynamics AX 2012

cubes to newer versions of the product.

By using the model-driven approach, you can create data entities by directly referencing aggregate

measurements and aggregate dimensions. These are known as aggregate data entities. Aggregate data entities

are read-only data entities that are used for reporting purposes. To consume aggregate data when you build

charts and other client controls, add the aggregate data to a form as a data source. You can also consume

aggregate data entities programmatically in C# or X++ code.

The Aggregate programming model lets a developer consume aggregate data programmatically by using either

X++ or C# code. Data that you retrieve by using the Aggregate programming model can be used as a data

source in forms and reports. A developer can add aggregate data that is modeled in perspectives to an

AXQuer yAXQuer y  object. The developer can also use an existing aggregate data entity to create a query that can be

extended by adding filters and additional columns that aren't present in the aggregate data entity. Bulk Move is a

capability that is associated with the Aggregate programming model. When a query is run by the kernel, the

developer can move all the records to a temporary or regular table without iterating row by row. Bulk Move

provides a very efficient way to move data from aggregate models to temporary tables.

Method expressions are a programming model for constructing rich calculations that are used to define fields in

a data entity. Method expressions enhance the computed column capability that was introduced in AX 2012

views. Method expressions let you build expressions by using the C# or X++ programming language. You can



In-memory, near-real-time aggregate measurements

KPI modeling and customization

NOTENOTE

also create calculations on aggregate data that was previously coded by using MDX. Method expressions can be

shared across the program.

Aggregate measurements are deployed to Microsoft SQL Server non-clustered column store indexes (NCCI).

Therefore, they can take advantage of the in-memory computing (IMC) engine that is built into Microsoft SQL

Server 2016 as Azure DB. Aggregate measurements that have the IMC engine as their destination are referred

to as in-memory, near-real-time (IM-NRT) aggregate measurements. These aggregate measurements don't

require that a Microsoft SQL Server Analysis Services (SSAS) server be used. Because these models don't

involve data updates, the queries that are sent to them reflect the latest state of data in the operational database.

That is why it's referred to as near-real-time.

In AX 2012 and earlier versions, KPIs and business indicators had to be modeled by using native SQL Server

development tools. Although users could pin a KPI or business indicator to a Role Center by using the BusinessBusiness

Over viewOver view  Web Part, they could not modify a KPI definition, such as the goal. Users can use a rich client form to

modify a KPI definition that was built and shipped by a developer. Users can also define new KPIs by using the

aggregate data that is contained in aggregate measurements. A developer can model a KPI definition in

Microsoft Visual Studio and ship it to a customer, either as a project or together with an independent software

vendor (ISV) solution. After a KPI is defined, users can customize it at run time.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Prerequisites

Key concepts

Set up

Import the tutorial projectImport the tutorial project

This tutorial will walk you through the process of modeling aggregate data.

This tutorial requires you to access the environment using Remote Desktop, and be provisioned as an

administrator. For more information, see the topic named Deploy and access development environments.

Aggregate measurementsAggregate measurements , similar to perspectivesperspectives  and CubesCubes  from earlier versions, enable you to

model and consume aggregate data.

Key Performance Indicators (KPIs)Key Performance Indicators (KPIs)  are a form of analytic controls that track organizational performance

against the current status. KPIs are represented as tiles in a workspaceworkspace or the dashboarddashboard. In this tutorial,

you will model a KPI in Visual Studio.

KPIs that are modeled in Visual Studio can be modified in the client. A user also has the ability to model new

KPIs using the client.

A workspaceworkspace is an overview page that is specific to a particular subject area. Workspaces are common to all

users.

The dashboarddashboard is the default home page for each user.

TilesTiles  are securable objects that can be pinned to a workspace or the dashboard. KPIs and aggregate data that

are shown on the dashboard, or a workspace, can be secured by using menu items.

Aggregate data can be consumed in building charts and other controls. Using the model driven approach,

you have the ability to create data entities by directly referencing aggregate measurements and aggregate

dimensions. These entities are referred to as Aggregate data entitiesAggregate data entities . Aggregate data entities are read-

only data entities used for reporting purposes.

The aggregate programming modelThe aggregate programming model  enables a developer to consume aggregate data programmatically

using either X++ or C# code. Data retrieved using the aggregate programming model can be used as a data

source in forms.

Method expressionsMethod expressions  enable a developer to build rich expressions using aggregate data. Method

expressions are an X++ class. KPIs can be modeled using method expressions, thereby eliminating the need

to build MDX expressions.

Contextual BIContextual BI refers to providing required insights as part of the user experience such that the user has

relevant insights to not only achieve the task at hand, but be highly-productive during the course of the day.

Embedded BIEmbedded BI refers to analytic content being embedded within the user experience. Contextual BI and

embedded BI teams are closely related. Contextual BI implies the added notion that the context of analytic

context revolves around the data or the task.

Self-ser vice BISelf-ser vice BI refers to enabling a user to tweak existing and/or create new analytic content such as

reports, KPIs, and dashboards.

If this is the first tutorial you are working on, make sure you have configured the administrator user if you are

running on a local VM.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/model-aggregate-data.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-tools/access-instances


Open the tutorial projectOpen the tutorial project

Model an aggregate measurement for rental charges

REN TA L  DAT EREN TA L  DAT E C USTO M ER GRO UPC USTO M ER GRO UP REN TA L  C H A RGE T Y P EREN TA L  C H A RGE T Y P E

RevenueRevenue X X X

Number of rentalsNumber of rentals X X X

Add a measure group for rental charges by using an existing viewAdd a measure group for rental charges by using an existing view

If you have already imported the Fleet management tutorial project, skip to the next section. In Visual Studio, on

the Dynamics 365Dynamics 365  menu, click Impor t ProjectImpor t Project.

1. Download the Fleet Management sample from https://github.com/Microsoft/FMLab, save it to c:\c:\ , and unzip

it.

2. In the Impor t ProjectImpor t Project window, next to the FilenameFilename text box, click the ellipsis button.

3. In the Select the file to impor tSelect the file to impor t window, browse to the location of the FMLabFMLab folder, click

FMTutorialDataModel.axppFMTutorialDataModel.axpp, and then click OpenOpen.

4. In the Project file locationProject file location text box, enter C:\FMLabC:\FMLab.

5. Select the Over write ElementsOver write Elements  check box, and then click OKOK.

1. In Visual Studio, open the FMTutorialFMTutorial  project. On the FileFile menu, point to OpenOpen, and then click

Project/SolutionProject/Solution.

2. In the Open ProjectOpen Project dialog box, browse to C:\FMLab\FMTutorial, and then click FMTutorial. Click OpenOpen. The

FMTutorialFMTutorial  project appears in Solution ExplorerSolution Explorer .

3. Use the FMTDataHelper class to load data for the Fleet Management tutorial. In Solution ExplorerSolution Explorer , in the

FMTutorial project, expand ClassesClasses . Right-click FMTDataHelperFMTDataHelper , and then click Set as Star tup ObjectSet as Star tup Object.

4. On the BuildBuild menu, click Rebuild SolutionRebuild Solution. You use the rebuild to update the timestamps of the imported

artifacts. You can view the build progress in the OutputOutput window.

5. Press Ctrl+F5 to run the project and load the data.

Often, when a user asks for additional information, you get a request for one or more new reports. Imagine that

the manager of a rental car company has called and asked for a report. The manager is interested in finding out

how the rental business is performing. The manager wants a report that shows rental revenue by month. You

soon find out that the manager is interested in a breakdown of rental revenues. The manager wants to know

whether the rental revenue is high in cases where they have sold additional services, for example, car seats, GPS,

re-fueling, as opposed to the base rental charge. As it turns out, the manager suspects that specific customer

groups are driving revenue up, and this is why the manager wanted the report in the first place. The manager

insists on adding Customer group to the report. Because the revenue must be considered in relation to the

number of rentals, the manager doesn’t want a few large corporate rentals to skew her analysis. You both agree

that the number of rentals needs to be shown along with revenue. We could represent this requirement as a set

of business questions using a matrix. Rows indicate the measuresmeasures  (or numbers) and the columns indicate the

dimensionsdimensions  (or slicers). An "X" in the intersection between a measure and a dimension indicates that the

measure needs to be "grouped by" the dimension.

Next, we will model an aggregate measurement to answer this business question.

In this section you will add a new measure group to an existing aggregate measurement.

1. In Solution ExplorerSolution Explorer , expand the AnalyticsAnalytics  folder of the project, and then double-click the aggregate

measurement, FMTAggregateMeasurementFMTAggregateMeasurement. The aggregate measurement will be launched in the

designer. Notice that the existing aggregate measurement contains two measure groups related to

vehicle inventory and rental details. You will create a new measure group related to rental charges.

https://github.com/Microsoft/FMLab
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Name FMRentalChargeExtendedView

Table FMRentalChargeExtendedView

P RO P ERT Y  ( EXT EN DEDA M O UN T )P RO P ERT Y  ( EXT EN DEDA M O UN T ) VA L UEVA L UE

Default Aggregate SumSum

Field ExtendedAmount (no change required)

Name Revenue

2. In Solution ExplorerSolution Explorer , expand the ViewsViews  folder of the project, and then select the

FMTRentalChargeExtendedViewFMTRentalChargeExtendedView  view.

3. Drag-and-drop the FMTRentalChargeExtendedViewFMTRentalChargeExtendedView  into the root node of the

FMTAggregateMeasurementFMTAggregateMeasurement aggregate measurement in the designer. Notice that a new measure

group is created and the values of properties have been applied as follows.

4. In Solution ExplorerSolution Explorer , double-click the FMRentalChargeExtendedViewFMRentalChargeExtendedView  view. When the designer form

opens, expand the FieldsFields  node.

5. Select the ExtendedAmountExtendedAmount and RentalIDRentalID fields, and then drag-and-drop the two fields onto the

MeasuresMeasures  node of the newly created FMAggregateMeasurementFMAggregateMeasurement measure group called

FMRentalChargeExtendedViewFMRentalChargeExtendedView . As you drag the fields, hover your cursor over the

FMAggregateMeasurementFMAggregateMeasurement tab to access the MeasuresMeasures  node. By default, when you drag-and-drop

the fields, the system assumes that you want counts of the measures. In this case, you need to modify

default properties for the ExtendedAmountExtendedAmount and RentalIdRentalId measures as follows:

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/fmtaggregatemeasurement.png


Model an aggregate dimension charge typeModel an aggregate dimension charge type

P RO P ERT Y  ( REN TA L ID)P RO P ERT Y  ( REN TA L ID) VA L UEVA L UE

Default Aggregate DistinctCountDistinctCount

Field RentalId (no change required)

Name NumRentals

6. Next let's create another measure which calculates Revenue per RentalRevenue per Rental  by copying an existing measure.

Select the TotalRevenueTotalRevenue measure. Right-click and select CopyCopy  from the ContextContext menu.

7. Select the FMRentalDetailsFMRentalDetails  measure group. Right-click and select paste. Rename the newly created

measure to RevenuePerRentalRevenuePerRental . Modify the aggregation function to AverageAverage.

To analyze rental revenue by the different charge types, you need to be able to slice revenue by the charge type.

For this purpose, you will first model a charge type dimension.

1. In Solution ExplorerSolution Explorer , under FMTutorialFMTutorial , right-click AnalyticsAnalytics , point to AddAdd, and then click New ItemNew Item.

2. Select Dynamics 365 Ar tifactsDynamics 365 Ar tifacts  > AnalyticsAnalytics  > Aggregate DimensionAggregate Dimension from the list of items.

3. In the NameName property, enter FMTChargeTypeFMTChargeType. This is the name of the aggregate dimension that will be

created. This name must be unique. Click AddAdd. The new dimension will appear in Visual Studio.

4. In Application ExplorerApplication Explorer , expand the AOTAOT and click Data ModelData Model  > TablesTables . Drag-and-drop the

FMTChargeTypeFMTChargeType table from Application ExplorerApplication Explorer  onto the root node of the newly created

FMTChargeTypeFMTChargeType dimension in the designer. Notice that dimension attributes and corresponding keys

have been added using the AutoReport field group of the table.

5. Expand the Attr ibutesAttr ibutes  node of the new dimension. Notice that several attributes have been created for

you by default. The system has also created a dimension key based on unique indexes of the table. You

can add additional fields by dragging and dropping them into the FieldsFields  node.

6. Save the new dimension.

7. You may get a warning asking you to rename the field name Description to avoid the MDX reserved

word. Even though the aggregate dimension may not be deployed to SSAS in this aggregate

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/fmtchargetype.png


Model dimension references for customer profile and charge type dimensionsModel dimension references for customer profile and charge type dimensions

measurement, it's possible that this dimension may be used by an aggregate measurement deployed to

SSAS in the future. To avoid potential issues in the future, rename the field name Descr iptionDescr iption to

ChargeDescr iptionChargeDescr iption.

Next, create dimension references to new and existing dimensions so that revenue can be sliced by customer as

well as charge type.

NOTENOTE

1. In Solution ExplorerSolution Explorer , double-click FMTAggregateMeasurementFMTAggregateMeasurement or, if you have it open, navigate to it

in the designer.

2. In Solution ExplorerSolution Explorer , select the dimensions FMTChargeTypeFMTChargeType and FMTCustomerProfileFMTCustomerProfile.

3. Drag-and-drop them into the DimensionsDimensions  node of the FMTRentalChargeExtendedViewFMTRentalChargeExtendedView  measure

group. Notice that dimension references have been created along with relations.

4. Save changes to FMTAggregateMeasurementFMTAggregateMeasurement. Review the property sheet for the dimension relation

and notice that the Use Table relationsUse Table relations  property is set to YesYes . Notice that the drag-and-drop operation

created relationships between the measure group dimensions FMTRentalChargeExtendedViewFMTRentalChargeExtendedView  and

FMTChargeTypeFMTChargeType, FMTCustomerProfileFMTCustomerProfile. Review the property sheet for the dimension relation and

notice that the Use Table relationsUse Table relations  property is set to YesYes .

In platform update 1611 and later, UseTableRelationsUseTableRelations property has been removed. When a new dimension

reference is created, system will default existing relationships. You can continue to provide an explicit relationship

by changing the relationship field that was defaulted. Providing an explicit relationship is equal to setting

UseTableRelationshipUseTableRelationship to NoNo.

5. Expand the Dimension relations node for the FMTCustomerProfileFMTCustomerProfile dimension. Notice that the

UseTableRelationsUseTableRelations  property is set to NoNo. In this case, the system has not been able to find a suitable

relationship between the Measure group and dimension. You will need to specify one manually.

6. Expand the FMTCustomerProfileFMTCustomerProfile dimension reference if you have not done so already. Select the node

FMTCustomerExtendedViewFMTCustomerExtendedView . Right-click and see the property sheet.

7. Select CustomerIDCustomerID as the value for property DimensionAttr ibuteDimensionAttr ibute. Select the relationship shown

below. Select CustomerCustomer  for the property value RelatedFieldRelatedField.

8. Save changes to FMTAggregateMeasurementFMTAggregateMeasurement.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/fmtchargetype2.png


Model dimension references for the date dimension's rental start date and transaction dateModel dimension references for the date dimension's rental start date and transaction date

9. In this scenario, we specified a relationship because the system was unable to find one. You could also

specify a different relationship if you want to override the system choice by setting Use Table RelationsUse Table Relations

proper typroper ty  to NoNo.

Assume that for analysis purposes, you want to enable slicing by the start date of the rental; but for accounting

purposes, you want to enable slicing by the transaction date for each of the charges. To do this, you need to

associate the rental charges measure group with two date dimensions. In the BI world, this pattern is known as

Role Playing dimensionsRole Playing dimensions . By default, a date dimension is added to the measure group. You can rename the

default name appropriately and add new date dimensions as required.

NOTENOTE

P RO P ERT YP RO P ERT Y VA L UEVA L UE

Name RentalStartDate

1. Expand the DimensionsDimensions  node of the FMTRentalChargeExtendedViewFMTRentalChargeExtendedView  measure group. Notice that the

Date_Date_  dimension has already been included as dimension slicers.

If the table or the view used to model the measure group is a Company-specific table, for example it contains

DATAAREAID as part of the key), a CompanyCompany dimension relation will be created by default. In this case, the view

we used is not a company specific one.

2. Select the DateDate dimension and specify the following properties.
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Use Table Relations No (This is the default – no need to change)
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Dimension Name Date_

[!NOTE] If you select the Dimension Name in the
wrong order, it will reset the other values you
already set.

Name TransactionDate

Use table relations No

Tags RolePlayingDate; Fleet

3. Define the table relationship. Expand RentalStar tDateRentalStar tDate, and then expand the DateDate node.

4. Select the Relationship shown. Right-click and select the property sheet. Select Star tDateStar tDate for the value of

Related fieldRelated field property.

5. The relationship you defined should look like the following screenshot.

6. Next, enable slicing of measures by the TransactionDate dimension. TransactionDate is also a date

dimension, so you will add another reference to the date dimension and associate that with the

corresponding field that contains the transaction date. When more than one date dimension is used as a

slicer, each date dimension is known as a Role playing date dimensionRole playing date dimension.

7. Under the FMTRentalChargeExtendedViewFMTRentalChargeExtendedView  measure group, right-click the DimensionsDimensions  node, and

then click New DimensionNew Dimension. A new dimension will be added to the list of dimension references.

8. Specify the following properties for the new dimension reference.



Deploy the newly generated aggregate measurementDeploy the newly generated aggregate measurement

O P T IO NO P T IO N C O N SIDERAT IO N SC O N SIDERAT IO N S

In-memory real-time This option will leverage the In-memory Column store
indexes of SQL Server database to deploy Aggregate
Measurements. This option is recommended when the
Aggregate measurement is used for embedded analytics
within the client where you need real-time analyticsreal-time analytics . For
an overview of concepts on real-time analytics, see Analytics,
aggregate measurements, and KPI modeling.

P RO P ERT YP RO P ERT Y VA L UEVA L UE

Field Date

Related Field TranDate

Notice the new property called TagsTags . This property enables the discovery of patterns within code and

metadata from within the Visual studio environment. You can enter any number of tags and they can be

searched using the hot keys or the Dynamics 365Dynamics 365  menu in Visual Studio.

9. Define the table relationship. Right-click TransactionDateTransactionDate, and then click New RelationNew Relation. You do not

need to specify any properties in the DimensionsRelation at this point.

10. Expand BIDateDimensionValueBIDateDimensionValue, and then select the RelationshipRelationship ConstraintConstraint. Right-click and select

the property sheet.

11. Specify the following properties for the BIDateDimensionsView relation constraint.

The relationship you defined should look like the following screenshot.

12. Save the aggregate measurement.

Now that you have completed modeling the aggregate measurement, you can deploy the aggregate

measurement and continue with building KPIs and visualizations. You have 2 deployment choices as shown

below.
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Stage in Entity Store This option leverages Entity store, the operational data store
that enables near real-time PowerBI repor tingnear real-time PowerBI repor ting. If you
choose this option, Aggregate measurement can be
deployed to Entity store and you can schedule the data to
be refreshed periodically. For an overview of this approach,
refer to the blog post here:
https://blogs.msdn.microsoft.com/dynamicsaxbi/2016/06/09
/power-bi-integration-with-entity-store-in-dynamics-ax-7-
may-update/

O P T IO NO P T IO N C O N SIDERAT IO N SC O N SIDERAT IO N S

NOTENOTE

Model a KPI to show revenue per rental
Model a KPI in Visual StudioModel a KPI in Visual Studio

SSAS CubeSSAS Cube option is no longer supported when modeling aggregate measurements.

1. Select the FMTAggregateMeasurementFMTAggregateMeasurement node. Right-click and select Proper tiesProper ties . Select

InMemor yRealTimeInMemor yRealTime as the value for the property UsageUsage.

2. InMemoryRealTime aggregate models are deployed to SQL Server using Non-Clustered Column Store

Index (NCCI) technology. NCCIs is an in-memory technology that enables analytical and operational

workloads to be served from SQL server database. NCCI indexes can be defined on tables similar to any

other index. While NCCI indexes can be defined manually, framework has the ability to analyze index

requirements and add them to underlying tables where necessary.

3. Right-click FMAggregateMeasurementFMAggregateMeasurement in Solution Explorer, and then click Add Column storeAdd Column store

indices optionindices option. You will notice several new indexes being added by the system.

4. Save and build the project.

5. InMemoryRealTime aggregate models do not require data processing as the models are queried real-

time. If you have not enabled database synchronization along with the build, manually synchronize the

database.

Model a KPI definition in Visual Studio by using the aggregate measurement you defined above.

1. In Solution ExplorerSolution Explorer , right-click FMTutorialFMTutorial , point to AddAdd, and then click New ItemNew Item.

https://blogs.msdn.microsoft.com/dynamicsaxbi/2016/06/09/power-bi-integration-with-entity-store-in-dynamics-ax-7-may-update/
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Measurement FMTAggregateMeasurement

Bad Threshold 0

Good Threshold 0

Scoring Pattern MoreIsBetter

Show Goal Yes

Show Status and Trend Yes

Threshold Type Value

NOTENOTE
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Value Type BasedOnMeasure

Measure Group FMTRentalChargeExtendedView

Measure RevenuePerRental

P RO P ERT YP RO P ERT Y VA L UEVA L UE

Goal Type BasedOnValue

Value 250

NOTENOTE

2. Select Dynamics 365 Ar tifactsDynamics 365 Ar tifacts  > AnalyticsAnalytics  > Key Performance IndicatorKey Performance Indicator . Enter

FMTRevenuePerRental as the name of the KPI, and then click AddAdd. The name must be unique across KPIs.

The KPI is created.

3. Select FMTRevenuePerRentalFMTRevenuePerRental , and specify the MeasurementMeasurement Leave the default values for the other

properties.

4. Define the expression for the KPI value. Under FMTRevenuePerRentalFMTRevenuePerRental , select ValueValue, and specify the

following properties.

The values must be entered in the order they appear in the table:

5. Define the expression for the KPI Goal. Select GoalGoal , and specify the following properties.

You could have defined a goal based on an aggregate measure as well. In this case, we will define a number as the

goal.

6. Save the KPI definition.



Preview KPI in clientPreview KPI in client

NOTENOTE

Next you will preview the KPI definition in the client.
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Threshold Type Percentage

Red if less than 90

Green if more than 110

1. Right-click FMTutorialFMTutorial , and then click Re-BuildRe-Build. On completion of the build, select the Synchronize ...Synchronize ...

databasedatabase option.

2. Open Internet Explorer, and navigate to your Rainier instance base URL.

3. Navigate to the Reser vation Management workspaceReser vation Management workspace under App linksApp links  > Fleet ManagementFleet Management >

WorkspacesWorkspaces  > Reser vation ManagementReser vation Management.

4. Select the KPI tile Total RevenueTotal Revenue. KPI details page for Total Revenueotal Revenue KPI will be displayed.

5. To navigate to the newly defined KPI, select the Show listShow list icon on top left. From the list of KPIs shown,

select FMTRevenuePerRentalFMTRevenuePerRental .

Notice that the KPI details page for the new KPI, FMTRevenuePerRentalFMTRevenuePerRental  is shown. Even though we did

not define trend charts, the system created a set of charts based on the limited metadata defined by the

developer. Users have the ability to modify KPI definitions and create new ones in the client. Next, you will

modify the newly defined KPI.

6. To demonstrate this capability, you can change the KPI Goal. Click the EditEdit button on top left, and enter

900 as the Goal Value.

7. Modify the threshold properties as follows:

8. Click SaveSave on the bottom left to save changes. Notice that the KPI status color has changed in the KPI tile

shown.
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How does this feature work?

This feature lets power users include financial dimensions in ready-made Microsoft Power BI reports. Power

users can also create new Power BI reports that use financial dimensions.

Financial dimensions are user-defined configuration data that enables the ledger chart of accounts to retain

additional information. By adding financial dimensions, a user can configure additional data fields that will be

included with the chart of accounts and financial reports. Therefore, the ledger chart of accounts can be sliced

and diced based on those fields. This feature provides powerful financial reporting. For example, you can explore

ledger data by using the new financial dimensions that you've added. Because no financial dimensions are

included in the ready-made Power BI reports when they are released, you must include these additional fields to

the ready-made reports.

After financial dimension fields are included in the report, you can share the report with other users. Those

other users can modify existing visuals, such as charts, by including all or some of the financial dimension fields.

This feature is available in Microsoft Dynamics 365 for Finance and Operations, Enterprise edition (July 2017). Platform

update 8 or later is also required.

The Entity store is an operational data warehouse that lets power users create reports. Whenever the Entity store

is updated, all available financial dimensions are included in it. We will look at an example from the LedgerLedger

ActivityActivity  aggregate measurement that contains General ledger journal-level details.

The following list shows some of the tables are filled in the Entity store when it's updated. Tables that have

changed are bold.

LedgerActivityMeasure_LedgerActivityMeasureGroup

LedgerActivityMeasure_TransactionDate

LedgerActivityMeasure_Currency

LedgerActivityMeasure_FiscalPeriodDateAggregtateDimension

LedgerActivityMeasure_LedgerFactDimension

LedgerActivityMeasure_FiscalYearOffsetDimension

LedgerActivityMeasure_MainAccount

LedgerActivityMeasure_DimensionCombinationLedgerActivityMeasure_DimensionCombination

LedgerActivityMeasure_Ledger

LedgerActivityMeasure_MainAccountCategory

LedgerActivityMeasure_Company

LedgerActivityMeasure_MainAccountLegalEntity

LedgerActivityMeasure_AgreementLedgerActivityMeasure_Agreement

LedgerActivityMeasure_BankAccountLedgerActivityMeasure_BankAccount

LedgerActivityMeasure_BusinessUnitLedgerActivityMeasure_BusinessUnit

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/add-financial-dimensions-aggregate-measurements.md


How a Power BI report author can create reports that use financial
dimensions

LedgerActivityMeasure_CampaignLedgerActivityMeasure_Campaign

LedgerActivityMeasure_CargoLedgerActivityMeasure_Cargo

LedgerActivityMeasure_Cargo_CNLedgerActivityMeasure_Cargo_CN

Notice that, for each financial dimension that is defined in your system, you might see a corresponding table in

the Entity store.

If you examine the LedgerActivityMeasure_DimensionCombination table, you will notice that the list of fields has

been expanded and now includes additional fields. Each new field corresponds to a financial dimension. For an

example, here are some of the additional fields:

Agreement_FK

Agreement_Description

Agreement_Value

BankAccount_FK

BankAccount_Description

BankAccount_Value

BusinessUnit_FK

BusinessUnit_Description

BusinessUnit_Value

If a user defines a new financial dimension that is named vendorvendor , when the Entity store is updated, a new table

is added that is named LedgerActivityMeasure_Vendor.

The LedgerActivityMeasure_DimensionCombination table will also contain the following new set of fields:

Vendor_FK

Vendor_Description

Vendor_Value

A business user can create a new report that uses financial dimensions by using Power BI desktop. Existing

reports that use financial dimensions can be updated so that they include additional fields.

In this example, we will use Power BI desktop to create a report that uses the Ledger Activity measure group.

1. In a development environment, connect to the Entity store database by using Power BI desktop.

2. Select the following tables:

LedgerActivityMeasure_LedgerActivityMeasureGroup

LedgerActivityMeasure_FiscalPeriodDateAggregtateDimension

LedgerActivityMeasure_DimensionCombination

3. Use the Manage relationshipsManage relationships  option in Power BI desktop to define the following relationships

between table fields:

Define a join between

LedgerActivityMeasure_LedgerActivityMeasureGroup.LEDGERDIMENSIONLedgerActivityMeasure_LedgerActivityMeasureGroup.LEDGERDIMENSION and

LedgerActivityMeasure_DimensionCombination.DIMENTIONCOMBINATIONRECIDLedgerActivityMeasure_DimensionCombination.DIMENTIONCOMBINATIONRECID.

Define a join between

LedgerActivityMeasure_LedgerActivityMeasureGroup.LEDGERGREGORIANDATEIDLedgerActivityMeasure_LedgerActivityMeasureGroup.LEDGERGREGORIANDATEID and

LedgerActivityMeasure_FiscalPer iodDateAggregateDimension.LEDGERPERIODGREGORIANDATEIDLedgerActivityMeasure_FiscalPer iodDateAggregateDimension.LEDGERPERIODGREGORIANDATEID.



4. Create a matrix report that uses the SalesSales  and YearNameYearName fields. The report should resemble the

following example.

Next, we will add financial dimension values.

5. In the list of fields in Power BI desktop, expand the LedgerActivityMeasure_DimensionCombinationLedgerActivityMeasure_DimensionCombination

table. You will see that the list of dimension fields is expanded into table fields, as shown here.

6. Include the BusinessUnit_Descr iptionBusinessUnit_Descr iption field in the report. Your report should now show sales by

business unit, as shown in the following example.

Notice that you have the BusinessUnit_descr iptionBusinessUnit_descr iption field and the BusinessUnit_ValueBusinessUnit_Value field. The value

field lets you to get a numerical value that can be used to sort columns.

7. Define a new financial dimension, and update the Entity store.

8. When the update is completed, right-click the LedgerActivityMeasure_DimensionCombinationLedgerActivityMeasure_DimensionCombination

table, and then select Refresh dataRefresh data. Notice that the new financial dimension that you defined is reflected

in the list of fields that are available for reporting.



Creating reports that use expanded Financial dimension tablesCreating reports that use expanded Financial dimension tables

How a developer can enable financial dimensions

9. You can include the new financial dimension fields in the report.

As we discussed earlier, new tables were created in the Entity store. Each financial dimension field is also added

to a new table. The new tables contain individual fields for the name, value, and description.

Notice that the new tables contain a key that can be used to join them with the

LedgerActivityMeasure_DimensionCombination table that is used to create the report. If you want to use fields

from these additional tables, just include them in the report and relate them by using the keys.

NOTENOTE

1. Open the report that you created earlier.

We will now add a financial dimension table to the report.

2. In Power BI desktop, click Recent SourcesRecent Sources  on the menu, and then select the AXDWAXDW data connection.

Table navigator is shown.

3. Select the LedgerActivityMeasure_LegalEntityLedgerActivityMeasure_LegalEntity  table for the report.

If you're using a development or demo environment, you see this table because LegalEntityLegalEntity  is a financial

dimension that is defined in demo data. If you're working with your own data, the tables that you see will

correspond to financial dimensions that you've defined.

We will now relate the selected table to existing tables in the report.

4. In the report, open the Manage relationshipsManage relationships  dialog box.

5. Join LedgerActivityMeasure_DimensionCombination.LegalEntity_FKLedgerActivityMeasure_DimensionCombination.LegalEntity_FK to

LedgerActivityMeasure_LegalEntity.KEY_LedgerActivityMeasure_LegalEntity.KEY_ .

If you select a different dimension table in step 3, you must relate the corresponding FieldName_FKFieldName_FK field from

the combination table to the KEY_KEY_  field in the dimension table.



What are financial dimension tables?What are financial dimension tables?

Creating role-playing financial dimensionsCreating role-playing financial dimensions

Before users can see expanded financial dimensions in the Entity store, a developer must enable the use of

financial dimensions in aggregate measurements. As a best practice, financial dimensions should be included

when you model any aggregate measurement that involves financial data. To include financial dimensions,

create an aggregate dimension that is based on “financial dimension tables.” As we saw earlier, an aggregate

dimension that you create by using financial dimension tables will be expanded at runtime.

Financial dimension tables are base tables that contain financial dimension data. Examples include

DimensionAttr ibuteValueCombinationDimensionAttr ibuteValueCombination and DimensionAttr ibuteValueSetDimensionAttr ibuteValueSet.

If you use a table, a view, or an entity that is based on those two tables, the fields of the aggregate dimension

will be expanded at runtime.

Consider the following example from the LedgerActivityMeasure aggregate measurement.

DimensionCombination is an aggregate dimension that is modeled by using the

DimensionAttributeValueCombination base table. In this case, the developer has referenced the aggregate

dimension by using the LedgerActivityMeasureGroup measure group.

At runtime, new dimension fields are added (that is, the DimensionCombination table is expanded) as new

financial dimensions are defined in the system.

When you report by using ledger data, you might require reporting on primary accounts and offset accounts.

For an example, if a ledger transaction involves the transfer of an amount from one account to another account,

the primary account is the "from" account, whereas the offset account is the "to" account. This pattern is known

as the role-playing dimensions pattern.

Both primary accounts and offset accounts must be associated with transaction data. Therefore, you must

expand financial dimension fields of both primary accounts and offset accounts. We will now see how you can

meet this requirement. Consider the following example.



NOTENOTE

We have modeled two dimension references for LedgerActivityMeaureGroup. The first reference,

DimensionCombination, is joined by using the LedgerDimensionLedgerDimension field. We saw this pattern earlier in this topic.

The second reference, OffsetDimensionCombination, is another reference to the same dimension. We have

reused the DimensionCombination aggregate dimension and given it a new name. In the second case, we can

join by using the OffsetLedgerDimensionOffsetLedgerDimension field.

At runtime, the system will expand both these dimensions with additional fields. Therefore, you can report on

primary and offset dimension fields.
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Accessing the local Entity Store by using DirectQuery
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Step 1: Populate the local Entity Store databaseStep 1: Populate the local Entity Store database

If you're a power user or a business analyst, you probably create many reports for your organization. You might

create these reports in Microsoft Excel by formatting and relating data before you share it with other people.

People in your organization might even come to you when they require modifications to the report. This

solution offers an easy way to create rich, interactive reports. As a report writer, you can use Microsoft Power BI

Desktop as the reporting tool. The reports that you create can then be published to PowerBI.com. For more

information about Power BI Desktop, see Create stunning reports and visualizations with Power BI Desktop.

You can create Microsoft Power BI reports by using Open Data Protocol (OData) endpoints that are exposed via

data entities. Despite the limitations of this approach, the Entity Store still supports it for legacy solutions.

However, DirectQuery is now the preferred method for sourcing data for analytical solutions. For more

information about the benefits and limitations of DirectQuery, see Use DirectQuery in Power BI Desktop.

When you use Power BI Desktop, you can create a report in your development or test environment by

connecting directly to the local Entity Store database. When you're satisfied with the report, your administrator

can help you migrate it to your production environment. The rest of this section walks you through this process.

To develop or extend analytical workspaces and reports in the application suite, customers must use a development

environment running in their own subscription or on local machines. You won’t be able to develop or extend embedded

analytical reports in Microsoft-provided Tier-1 environments. You need administrator rights to install Power BI Desktop.

Tier-1 environments now include a service compatible version of Power BI Desktop. To develop or extend

analytical workspaces and reports in the application suite, customers can use the Power BI Desktop

application pre-installed on the development environment. Alternatively, you can use the latest compatible

release of Power BI Desktop with Preview features turned off to author analytical reports for Finance and

Operations apps. Download the August 2020 Update of Power BI Desktop at Previous monthly updates to

Power BI Desktop.

For this example, we will stage the aggregate models that the Commerce analytical solution consumes in the

local Entity Store. The models that the application uses are defined in the RetailCube aggregate measurement.

1. In the client, open the Entity StoreEntity Store page. (Select System administrationSystem administration > SetupSetup > Entity StoreEntity Store.)

2. Select the RetailCubeRetailCube aggregate measurement, and then select RefreshRefresh.

3. Enter a name for the job that will be run in the background, and then select OKOK.

The following illustration shows the administrator dialog box that is used to configure the frequency of updates

for the aggregate model.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/author-distribute-power-bi-reports.md
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Step 2: Connect to the local Entity Store databaseStep 2: Connect to the local Entity Store database

To monitor the progress of the job that stages the data, you can use the batch job monitoring page. (Select

System administrationSystem administration > DatabaseDatabase > Batch jobsBatch jobs .) If you're using demo data, the job should take about a

minute. After the data is in the Entity Store, you can write reports.

1. Start Power BI Desktop. If any updates are available for Power BI Desktop, you might have to download

and apply them.

2. On the Power BI WelcomeWelcome page, select Get dataGet data.

Alternatively, when Power BI Desktop starts, you can select Get DataGet Data > SQL Ser verSQL Ser ver .

3. In the SQL Ser ver DatabaseSQL Ser ver Database dialog box, enter .. as the server name and AxDWAxDW as the database name.

Then select the DirectQuer yDirectQuer y  option.

The following illustration shows the settings that enable Power BI Desktop to access the local Entity Store

database.



NOTENOTE
The Impor tImpor t  option isn't currently supported.

4. Select OKOK.

The NavigatorNavigator  dialog box appears. You use this dialog box to select which tables and views from the

Entity Store you want to report on.

5. In the search box, enter RetailRetail  to filter for entities that are related to the RetailCube aggregate

measurement.

6. Select the RetailCube_RetailTransDetailsViewRetailCube_RetailTransDetailsView  table that is shown in the navigator, and then select

LoadLoad.

You can now create a report. You can drag measures and fields to the canvas, and can explore data and trends

interactively.

The following illustration shows a basic report that uses the local Entity Store database as its source.



Validating reports in a demo environment

NOTENOTE

Power BI Desktop also supports the creation of calculations and lets you combine data from multiple aggregate

measurements. Within minutes, you can create analytical reports by using data in the local development

environment. When you're satisfied with the report, you can migrate it to the production environment, so that

users can use the report to interact with production data.

The report shows the demo or test data in your developer environment. If you want to integrate the report into

a demo environment, you can continue to publish this report to your PowerBI.com account and pin it to the

client.
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Introduction

Prerequisites

Overview

NOTENOTE

Add a .pbix file as a resource

This feature is supported in Finance and Operations (version 7.2 and later).

This topic shows how to embed a Microsoft Power BI report on the AnalyticsAnalytics  tab of a workspace. For the

example that is given here, we will extend the Reser vation managementReser vation management workspace in the Fleet Management

application to embed an analytical workspace on an AnalyticsAnalytics  tab.

Access to a developer environment that runs Platform update 8 or later.

An analytical report (.pbix file) that was created by using Microsoft Power BI Desktop, and that has a data

model that is sourced from the Entity store database.

Whether you extend an existing application workspace or introduce a new workspace of your own, you can use

embedded analytical views to deliver insightful and interactive views of your business data. The process for

adding an analytical workspace tab has four steps.

1. Add a .pbix file as a Dynamics 365 resource.

2. Define an analytical workspace tab.

3. Embed the .pbix resource on the workspace tab.

4. Optional: Add extensions to customize the view.

For more information about how to create analytical reports, see Getting started with Power BI Desktop. This page is a

great source for insights that can help you create compelling analytical reporting solutions.

Before you begin, you must create or obtain the Power BI report that you will embed in the workspace. For more

information about how to create analytical reports, see Getting started with Power BI Desktop.

Follow these steps to add a .pbix file as a Visual Studio project artifact.

1. Create a new project in the appropriate model.

2. In Solution Explorer, select the project, right-click, and then select AddAdd > New ItemNew Item.

3. In the Add New ItemAdd New Item dialog box, under Operations Ar tifactsOperations Ar tifacts , select the ResourceResource template.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/add-analytics-tab-workspaces.md
https://powerbi.microsoft.com/documentation/powerbi-desktop-getting-started/
https://powerbi.microsoft.com/documentation/powerbi-desktop-getting-started/


Add a tab control to an application workspace

4. Enter a name that will be used to reference the report in X++ metadata, and then click AddAdd.

5. Find the .pbix file that contains the definition of the analytical report, and then click OpenOpen.

Now that you've added the .pbix file as a Dynamics 365 resource, you can embed the reports in workspaces and

add direct links by using menu items.

In this example, we will extend the Reser vation managementReser vation management workspace in the Fleet Management model by

adding the AnalyticsAnalytics  tab to the definition of the FMClerkWorkspaceFMClerkWorkspace form.

The following illustration shows what the FMClerkWorkspaceFMClerkWorkspace form looks like in the designer in Microsoft

Visual Studio.



Follow these steps to extend the form definition for the Reser vation managementReser vation management workspace.

1. Open the form designer to extend the design definition.

2. In the design definition, select the top element that is labeled Design | Pattern: Workspace OperationalDesign | Pattern: Workspace Operational .

3. Right-click, and then select NewNew  > TabTab to add a new control that is named FormTabControl1FormTabControl1 .

4. In the form designer, select FormTabControl1FormTabControl1 .

5. Right-click, and then select New Tab PageNew Tab Page to add a new tab page.

6. Rename the tab page to something meaningful, such as WorkspaceWorkspace.

7. In the form designer, select FormTabControl1FormTabControl1 .

8. Right-click, and then select New Tab PageNew Tab Page.

9. Rename the tab page to something meaningful, such as AnalyticsAnalytics .

10. In the form designer, select Analytics (Tab Page)Analytics (Tab Page) .

11. Set the CaptionCaption property to AnalyticsAnalytics , and set the Auto DeclarationAuto Declaration property to YesYes .

12. Right-click the control, and then select NewNew  > GroupGroup to add a new form group control.

13. Rename the form group to something meaningful, such as powerBIRepor tGrouppowerBIRepor tGroup.

14. In the form designer, select PanoramaBody (Tab)PanoramaBody (Tab) , and then drag the control onto the WorkspaceWorkspace tab.

15. In the design definition, select the top element that is labeled Design | Pattern: Workspace OperationalDesign | Pattern: Workspace Operational .

16. Right-click, and then select Remove patternRemove pattern.

17. Right-click again, and then select Add patternAdd pattern > Workspace TabbedWorkspace Tabbed.

18. Perform a build to verify your changes.

The following illustration shows what the design looks like after these changes are applied.



NOTENOTE

Add X++ business logic to embed a viewer control

Now that you've added the form controls that will be used to embed the workspace report, you must define the

size of the parent control so that it accommodates the layout. By default, both the Filters PaneFilters Pane page and the

TabTab page will be visible on the report. However, you can change the visibility of these controls as appropriate for

the target consumer of the report.

For embedded workspaces, we recommend that you use extensions to hide both the Filters PaneFilters Pane and TabTab pages, for

consistency.

You've now completed the task of extending the application form definition. For more information about how to

use extensions to do customizations, see Customize through extension and overlayering.

Follow these steps to add business logic that initializes the report viewer control that is embedded in the

Reser vation managementReser vation management workspace.

1. Open the FMClerkWorkspaceFMClerkWorkspace form designer to extend the design definition.

2. Press F7 to access the code behind the code definition.

3. Add the following X++ code.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/extensibility/customization-overlayering-extensions


[Form] 
public class FMClerkWorkspace extends FormRun
{
    private boolean initReportControl = true;
    protected void initAnalyticalReport()
    {
        if (!initReportControl)
        {
            return;
        }
        // Note: secure entry point into the Workspace's Analytics report
        if (Global::hasMenuItemAccess(menuItemDisplayStr(FMClerkWorkspace), MenuItemType::Display))
        {
            // initialize the PBI report control using shared helper
            PBIReportHelper::initializeReportControl('FMPBIWorkspaces', powerBIReportGroup);
        }
        initReportControl = false;
    }
    /// <summary>
    /// Initializes the form.
    /// </summary>
    public void init()
    {
        super();
        this.initAnalyticalReport();
    }
}

4. Perform a build to verify your changes.

You've now completed the task of adding business logic to initialize the embedded report viewer control. The

following illustration shows what the workspace looks like after these changes are applied.



NOTENOTE

Reference
PBIReportHelper.initializeReportControl methodPBIReportHelper.initializeReportControl method

SyntaxSyntax

public static void initializeReportControl(
    str                 _resourceName,
    FormGroupControl    _formGroupControl,
    str                 _defaultPageName = '',
    boolean             _showFilterPane = false,
    boolean             _showNavPane = false,
    List                _defaultFilters = new List(Types::Class))

ParametersParameters

N A M EN A M E DESC RIP T IO NDESC RIP T IO N

resourceName The name of the .pbix resource.

formGroupControl The form group control to apply the Power BI report control
to.

defaultPageName The default page name.

showFilterPane A Boolean value that indicates whether the filter pane should
be shown (truetrue) or hidden (falsefalse).

showNavPane A Boolean value that indicates whether the navigation pane
should be shown (truetrue) or hidden (falsefalse).

defaultFilters The default filters for the Power BI report.

NOTENOTE

You can access the existing operational view by using the workspace tabs below the page title.

This section provides information about the helper class that is used to embed a Power BI report (.pbix resource)

in a form group control.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Help secure analytical workspaces and reports by
using Power BI Embedded
2/18/2021 • 5 minutes to read • Edit Online

NOTENOTE

Introduction

Prerequisites

Overview

RecommendationRecommendation

This feature is supported in Microsoft Dynamics 365 for Finance and Operations, Enterprise edition (July 2017) (version

7.2) and later releases.

This topic provides a walk-through for application developers who want to help secure analytical workspaces

and reports that are delivered by using Microsoft Power BI Embedded. It describes the recommended strategies

for securing access to both the reports and the data set, based on viewer access rights. By using the techniques

that are described in this topic, you can hide reports from users and filter reports to show the data set that is

appropriate for a specific user, based on the active company context.

Access to a developer environment that runs Platform update 8 or later

An analytical report (.pbix file) that was created by using Microsoft Power BI Desktop, and that has a data

model that is sourced from the Entity store database

Whether you're extending an existing application workspace or adding your own workspace, you can use

embedded analytical views to deliver insightful and interactive views of your business data. Before you add new

analytical workspaces and reports, it's important that you establish a strategy to help secure the content.

There are several considerations that you should be aware of when you develop analytical solutions by using

Power BI Embedded. Analytical reports are secured by using menu items. After they have access to a report, all

viewers can access the underlying data model that is defined in the report. Although service options are

available that automatically hide the fields that back a report data set, all viewers of the report have effective

access to the fields in the data model. Additionally, X++ extensions are available that influence the way that the

report is presented in the client. Both the FilterFilter  pane and the Repor tRepor t tabs can be hidden. However, Microsoft

Power BI filters can be modified by using client-side script injections.

Create scenario-specific .pbix files to deliver analytical views:

NOTENOTE

Area overviews that are delivered by using workspaces

Subject matter–specific analytical reports

These analytical reports are often used to deliver reports that contain medium-business-impact and high-

business-impact data.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/secure-analytical-workspaces.md


Help secure analytical views that are provided through embedded
Power BI reports

Help secure analytical workspaces on the Analytics tabHelp secure analytical workspaces on the Analytics tab

Help secure analytical reportsHelp secure analytical reports

For more information about how to create analytical reports, see Getting started with Power BI Desktop. This

page is a great source for insights that can help you create compelling analytical reporting solutions.

Power BI report filters and the FilterFilter  pane serve as a mechanism for passing session context into the report that

is embedded on the AnalyticsAnalytics  tab. The capability to turn the visibility of the FilterFilter  pane on and off isn't a

security feature. Power BI report filters and the capability to hide and show the FilterFilter  pane are user experience

(UX) decisions that the application designer makes.

Row-level security that is defined isn't inherited by Power BI reports. Instead, application developers can help

secure the workspace or the report.

Analytical workspaces are embedded Power BI reports that are shown in a form control. Unless you complete

the following procedure, anyone who has access to the workspace can see the AnalyticsAnalytics  tab and access the

Power BI reports.

// Note: secure entry point into the Workspace's Analytics report
if (Global::hasMenuItemAccess(menuItemDisplayStr(FMClerkWorkspace), MenuItemType::Display))
{
    FMPBIWorkspaceController controller = new FMPBIWorkspaceController();
    PBIReportHelper::initializeReportControl('FMPBIWorkspaces', powerBIReportGroup);
}

1. Add a menu item for the analytical workspace.

2. Verify that the form initialization uses the hasMenuItemAccesshasMenuItemAccess  application programming interface (API)

to verify that the user has access to the menu item.

The preceding logic will prevent the Power BI Viewer control from being initialized. Therefore, an empty tab will

appear on the page. By default, the framework automatically hides empty tabs. Therefore, the AnalyticsAnalytics  tab is

hidden and can't be access if the user doesn't have access to the menu item that is associated with the analytical

workspace.

Embedded Power BI reports in the application are secured by using menu items. Users who try to access a

Power BI report directly, by using a menu item in application, will receive an error. Follow these steps to help

secure the analytical reports.

1. Add a menu item for the report or the appropriate tab. By default, the first tab of the report will be shown

if no other tab is selected.

2. Link the menu item to the PowerBIEmbedded_AppPowerBIEmbedded_App configuration key.

https://powerbi.microsoft.com/documentation/powerbi-desktop-getting-started/


Help secure analytical workspaces and reports by company

The menu item is now associated with the availability of the Power BI Embedded service. If the service is

unavailable, the links for the menu items will be removed from the application.

Power BI workspaces and reports can be secured by company (for example, DataAreaIDDataAreaID value). Application

solutions must apply the following steps for company-level security in analytical workspaces and reports.

In this scenario, the workspaces and reports that the sales manager from Contoso USA sees are limited to data

that is related to Contoso USA. The report viewer must not have access to data that associated with any other

company, unless the company context is changed.

1. Open the analytical report in Power BI Desktop by double-clicking the resource in a Microsoft Visual

Studio project.

2. On the ModelingModeling tab, click Manage RolesManage Roles .

3. Create a new role against a column in the data model that contains the CompanyCompany  field. Name the new

role CompanyFilterCompanyFilter . A COMPANYCOMPANY field must be present in the data model to restrict access by

company.



NOTENOTE

4. In the Table filter  DAX expressionTable filter  DAX expression field, enter [COMPANY]=username()[COMPANY]=username() .

5. To make sure that the rules work, on the ModelingModeling tab, click View as RolesView as Roles . In the dialog box, set the

following fields:

a. Clear the NoneNone check box.

b. Select the Other userOther user  check box, and then enter USMFUSMF in the text box.

c. Select the CompanyFilterCompanyFilter  check box.

The reports will now show data as if you're running the USMF company.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create reporting solutions
2/18/2021 • 10 minutes to read • Edit Online

Prerequisites

Key concepts

What's new in Reporting?

What is a report in Dynamics 365 Finance and Operations apps?

This tutorial shows how to export data and create a report, expand predefined views and add navigation to

charts, use the free-form report designer, and customize the parameter experience.

For this tutorial, you must access the application environment, and you must be provisioned as an administrator

on the instance.

Describe the various ways reports can be created and consumed

Add interactivity to embedded aggregate reports in forms and workspaces

Use framework extensions to customize the parameter experience for SSRS based business documents

Export List Page data to create reports with external tools including Microsoft Excel

Author modern report designs using enhanced developer tooling in Visual Studio

Embedded report drill-through navigations to AX forms and reports

Navigate between reports using embedded report drill-through links

Several Document Routing Service enhancements including support for custom print settings

Introduced Document Brand Management administrative tools

Additional visualizations available through the Embedded Charting Control

Dates and Amounts in the report body are formatted based on the "Date, time, and number format" user

setting

Network Print monitoring form

Table extensions need to be supported through the VS Query picker

Reports can be defined simply as any visualization of a structured data set. This may include transactional data

presented in a tabular layout and advanced graphical views of aggregate information. To account for this broad

definition, the application offers several tools to produce reports to satisfy complex business requirements.

Some common applications of reports in an ERP include:

Creating and archiving transactional documents as part of a posting process

Producing packing slips for tracking orders from Manufacturing to Warehousing to Sales

Monitoring key performance metrics and surfacing trends in data

Navigating the client through filtered searches

Distributing heavily branded documents to customers and employees

Extracting data in such a way that it articulates the health of a business

The most difficult task for developers is selecting the right Business Intelligence visualization tool for the job,

given a customer's requirements. To accomplish this, it's important to understand the capabilities offered

through the tools that are available for creating reports. We offer tooling to support the following basic

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/create-nextgen-reporting-solutions.md


TO O LTO O L A UT H O RA UT H O R TA RGETTA RGET DATADATA C O N SUM P T IO NC O N SUM P T IO N DESIGN ERDESIGN ER

Excel Power User Power User Transactional External Free form

Embedded BI Developer All users Aggregates Internal Modeled

SSRS Report Developer All users Transactional and
Aggregates

Internal/External Free form

Power BI Power User All users Aggregates Internal/External Free form

Management
Reporter

Power User Power User Transactional External Modeled

Create a report using List Pages

Create an analysis report based on all rentals in Fleet Management that are marked as completeCreate an analysis report based on all rentals in Fleet Management that are marked as complete

reporting requirements:

Excel IntegrationExcel Integration – Allows data management and analysis using Microsoft Excel

Embedded AnalyticsEmbedded Analytics  – Add aggregate data to a Workspaces using native controls like charts and grids

Repor ting Ser vicesRepor ting Ser vices  – Create business documents that require precision using SSRS-based solutions

Power BI IntegrationPower BI Integration – Author and share reports that can be accessed anywhere

Management Repor terManagement Repor ter  – Designed to help users create financial reports

The following table can be used to compare the basic characteristics of these reporting tools:

In this section, we'll walk you through the process of exporting data displayed in an entity details form. Here

we'll demonstrate how every form in can be viewed as a source of data for management and analysis using the

power of Excel.

1. Open Internet Explorer, and navigate to your instance base URL and sign in.

a. On the cloud environment, the base URL is obtained from LCS

b. On a local VM, the base URL is https://usnconeboxax1aos.cloud.onebox.dynamics.com .

2. On the Dashboard, scroll to the far right, and click the Reser vation managementReser vation management tile.

3. Under the Summar ySummar y  section, click on the All rentalsAll rentals  tile.

4. Expand the FiltersFilters  pane by clicking on the Filters icon next to the main grid.

5. Click Add a filter  fieldAdd a filter  field, and then select StatusStatus  in the drop-down list.

6. Enter CompleteComplete in the Status filter field, and then click ApplyApply .

7. Expand the page action bar, click Open in OfficeOpen in Office, and then select RentalsRentals .



Advantages of List PagesAdvantages of List Pages

Expand predefined views and add navigation to charts

After the data has been exported, you can use the power and flexibility of the Excel tools to create reports

for presentation or additional analysis. The following is an example of a self-service report authored with

Excel.

8. Close the browser session and the exported Excel file.

Flexible source for accessing transactional business data using external reporting and analytical tools like

Excel

Allows end-users to model the data sets they need without requiring a developer

Direct access to real-time business information

Business Intelligence can be useful at every level of an organization. Use embedded controls to elevate the most

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/fmrentals-export.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/fmrentals-analysis.png


Create development projectCreate development project

Change the default chart type for the visualizationChange the default chart type for the visualization

relevant information based on the target persona. Native controls offer users an intuitive and convenient way of

interacting with aggregate data allowing for informed decision making.

1. On the Desktop, right-click the Visual StudioVisual Studio shortcut, and select Run as administratorRun as administrator  to open the

development environment.

2. On the toolbar, click ViewView , and then select Application ExplorerApplication Explorer

3. Use the Application ExplorerApplication Explorer  to search for the FMReser vationsRepor tFMReser vationsRepor t form in the FleetFleet

ManagementManagement module.

4. In the Application Explorer 'sApplication Explorer 's  search results, right-click FMReser vationsRepor tFMReser vationsRepor t form, and then select

Add to new projectAdd to new project.

5. Select the Finance and Operations ProjectFinance and Operations Project template, and then click OKOK to create the project.

6. In Solution ExplorerSolution Explorer , right-click FMReser vationsRepor tFMReser vationsRepor t menu item, and then select Set as star tupSet as star tup

object.object.

7. Press Ctrl+Shift+B to save and build the project.

8. Press Ctrl+F5 to load the form containing the report.

At this point, you have a collection of pre-defined chart visualizations of Aggregate data. The controls offer basic

interactive features like hover text, series filtering, and touch expansion. However, it is often appropriate that a

greater degree of user interactivity is required.

1. Close the browser session and return to the Visual Studio project.

2. Open the Application ExplorerApplication Explorer , locate the FMReser vationsByCustPar tFMReser vationsByCustPar t form, right-click, and then select

Add to projectAdd to project.

3. Open the FMReser vationsByCustPar tFMReser vationsByCustPar t form designer.

4. Access the Ser iesSeries  collection in the Reser vationsByCustReser vationsByCust chart definition.

5. Select the SysBuildChatMeasure1SysBuildChatMeasure1  series definition

6. Locate the AppearanceAppearance section in the Proper tiesProper ties  window.

7. Update the Char t typeChar t type value and select PiePie

8. Press Ctrl+Shift+B to save and rebuild the project.

9. Press Ctrl+F5 to run the report.

The Reser vations by customerReser vations by customer  view now visualizes the aggregate data set using a Pie chart to simplify the

task of comparing rental activity across customers.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/fmcustomer-activity.png


Advantages of embedded aggregate visualizationsAdvantages of embedded aggregate visualizations

Using the freeform report designer

Open the Precision DesignerOpen the Precision Designer

Additional functions include:

Define contextual drill-through navigations using modeled properties

Manage drill-through links using X++ form logic

Designed to be simple and intuitive to promote informed decisions at every level of the organization

Pre-defined views tailored to meet the needs of the consumer

Augments the user's ability to recognize key performance trends in the data

SSRS continues to be the platform for producing advanced Business Document solutions for your ERP

application. The hosted service is designed for high volume and heavily transactional reports with an integrated

parameter experience. Backed by the Document Printing & Distribution Services, these solutions are ideal for

producing precision documents which are intended for email, printing, archive, and bulk distribution.

1. Close the browser session and return to the Visual Studio project.

2. Click FileFile > Close SolutionClose Solution, to close the active project.

3. Use the Application ExplorerApplication Explorer  to search for objects with FMRentalsByCustFMRentalsByCust in the name

4. In the Application Explorer 'sApplication Explorer 's  search results, select all ClassesClasses , the Output Menu ItemOutput Menu Item, and the

FMRentalsByCustomerFMRentalsByCustomer  report

5. Right-click and then select Add to new projectAdd to new project.

6. Select the Dynamics 365Dynamics 365  template, and then click OKOK to create the project.

7. In Solution ExplorerSolution Explorer , double-click on the FMRentalsByCustomerFMRentalsByCustomer  report to open the designer.

8. Expand the DesignsDesigns  collection in the designer to view the list of design definitions

9. Double-click on the Repor tRepor t design to view the report definition using the Precision Designer

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/fmcustomer-activity-2.png


Customizing the parameter experience

Defining parameters defaulting using codeDefining parameters defaulting using code

The above is a screen-shot of the FMRentalsByCustomer report design definition as viewed using the Visual

Studio Precision Designer. The Precision Designer offers a free-form design surface with built-in tools that allow

you to customize the content and layout of the report. You can also take advantage of embedded VB code to

create run-time design manipulations and support user interactions. As an integrated tool, developers are able

to reference AX labels and public APIs to format data in the report body based on AX EDTs. MSDN offers a rich

collection of developer documentation related to SSRS formatting capabilities. See the article Reporting

Services Reports (SSRS) on for a good primer on designing effective SSRS reports.

The Reporting Framework offers flexibility through service extensions to facilitate advanced solutions with

requirements that cannot be addressed using a modeled solution. Use the VS designer to add basic parameter

formatting, grouping, and input validation. X++ based data contract validation is available for more advanced

scenarios. Consider adding User Interface (UI) Builder Classes to customize the parameter pane used to prompt

for session inputs before running a report. These custom extensions are effective for addressing the following

functions:

Overriding dialog field events

Validating report parameters inline

Adding customized lookups to dialog fields

Changing the layout of the dialog controls

Adding custom controls including images

1. In Solution ExplorerSolution Explorer , double-click on the FMRentalsByCustUIBuilderFMRentalsByCustUIBuilder  class to open the designer.

2. Locate the class buildbuild method and update the initialization code as follows

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/report-designer.png
https://msdn.microsoft.com/library/bb522712.aspx


NOTENOTE

Using VB code to manage running balances

public void build()
{
    Dialog dialogLocal = this.dialog();
    contract = this.dataContractObject() as FMRentalsByCustContract;// associate dialog field with 
data contract method
    this.addDialogField(methodStr(FMRentalsByCustContract, parmCustGroupId), 
contract);dialogLocal.addGroup("@SYS41297");
    fromDateField = this.addDialogField(methodStr(FMRentalsByCustContract, parmFromDate), contract);
    toDateField = this.addDialogField(methodStr(FMRentalsByCustContract, parmToDate), contract);// 
set the default date range values
    fromDateField.value(today() - 365);
    toDateField.value(today());
}

3. Press Ctrl+Shift+B to save and rebuild the project.

4. Press Ctrl+F5 to run the report.

The parameter initialization code above sets the default values of the report execution relative to today's date.

Use the classes UIBuilder to override the framework's default handling of report parameters. Additional

extension scenarios supported:

Automatically set query ranges based on session context using Controller classes

Select report designs at runtime using a shared menu item

Modify report data contract values using business logic

This example demonstrates a UIBuilder extension with an RDP-based based report. For a Query based example that

includes a UIBuilder extension, view the FMCustomerListFMCustomerList  report.

The Reporting Framework offers flexibility through service extensions to facilitate advanced solutions with

requirements that cannot be addressed using a modeled solution. Use the VS designer to add basic parameter

formatting, grouping, and input validation. X++ based data contract validation is available for more advanced

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/fmrentalsbycust-controls.png


Import the section resourcesImport the section resources

scenarios. Consider adding User Interface (UI) Builder Classes to customize the parameter pane used to prompt

for session inputs before running a report. These custom extensions are effective for addressing the following

functions:

Overriding dialog field events

Validating report parameters inline

Adding customized lookups to dialog fields

Changing the layout of the dialog controls

Adding custom controls including images

1. Close the browser session and return to the Visual Studio project.

2. On the toolbar, click DYNAMICS AXDYNAMICS AX, and then select Impor t Project…Impor t Project…

3. In the File name window, browse to C:\FmLab\Lab10-3, select FMRentalDetailsRepor t.axppFMRentalDetailsRepor t.axpp, and then click

OpenOpen.

4. In the Project file location text box, enter C:\FmLab\Lab10-3.

5. Select the Current solutionCurrent solution radio button.

6. Click OKOK to close. Wait for the project to be imported and opened.

7. In the Solution ExplorerSolution Explorer , select the new project, right-click, and then select Set as star tup project.Set as star tup project.

8. In the Solution ExplorerSolution Explorer , right-click FMRentalDetailsFMRentalDetails  menu item, and then select Set as star tup object.Set as star tup object.

9. Select the Project in Solution Explorer, right-click, and then select Deploy Repor tsDeploy Repor ts

10. Press Ctrl+F5 to view the report.

This report uses embedded VB script to keep track of running totals so that the balances from the previous page

can be referenced on the active page. To inspect report's VB code, load the report design in the Precision

Designer, access the Repor t Proper tiesRepor t Proper ties , and then select the CodeCode section. Here you'll see several functions

referenced by the report designs to surface running balances within the report headers and footers.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/fmrentaldetails-report.png


Advantages of SSRS reportsAdvantages of SSRS reports

NOTENOTE

Built-in back office document management capabilities including email support, scheduled executions via

Batch, and Print Archive

Parameterized views with drill-through navigations to forms and other reports

Used to produce precision documents for compliance with local regulatory business practices

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Customize App Suite reports by using extensions
2/18/2021 • 2 minutes to read • Edit Online

Scenarios

NOTENOTE

This topic discusses a series of scenarios for customizing App Suite reports.

Finance and Operations offers an expanded set of tools to support custom solutions. Customizations to

reporting solutions in the standard application are fully supported using a pure extension model. This topic

contains guidance about how to add the most common customizations to standard application reports without

overlayering Application Suite artifacts. Here are some of the key benefits of using an extension-based approach

when customizing the application:

It reduces the footprint of your application solutions by minimizing code duplication.

Custom reports benefit from enhancements made to standard solutions including updates to business logic

in Report Data Provider (RDP), data contracts, and UI Builder classes.

Standard application solutions are unaffected and continue to be available in concert with custom reports.

Report extensions do not break or prevent access to standard application reports. Instead, the platform supports

run-time selection of the target report allowing you to choose the appropriate report design based on the

context of the user session. For more information about customizations using extensions, see Customize

through extension and overlayering

There are four key scenarios which demonstrate the flexibility available. The first two scenarios involve

extending existing RDP classes for custom reporting solutions.

Expand Application Suite report data sets – Use table extensions and integrate custom business logic to add

custom columns to an existing dataset.

Composing custom datasets – Add more data to application reports by extending an existing RDP class to

return a custom dataset.

The other two scenarios offer insights on how to use extensions to redirect application navigations to your

custom solutions.

Extend report menu items to redirect user navigation – Customize application menu items to redirect

references to a custom report design.

Create custom designs for business documents – Delegate handlers allow you to add custom report designs

to an existing Print Management document instance.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/customize-app-suite-reports-with-extensions.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/extensibility/customization-overlayering-extensions
https://aka.ms/BAG_Docs_Language_Survey
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What's important to know?

This topic shows how to expand an existing report data set that is produced by using X++ business logic in a

report data provider (RDP) class.

This topic focuses on the expansion of an existing report data set that is produced by using X++ business logic

in a report data provider (RDP) class. You use custom delegate handlers and table extensions to include

additional field data and/or calculations. You don't have to over-layer the Application Suite. You then create

custom designs that replace the standard application solutions and present the data to users. The following

illustration shows a typical application customization, as described in this topic.

There are a few basic assumptions that you should be aware of before you apply this solution.

You can't directly extend RDP classes.You can't directly extend RDP classes. However, the platform provides extension points that enable

data set expansion without duplicating business logic in the standard application.

There are two methods that can be used to expand repor t data sets.There are two methods that can be used to expand repor t data sets. Use the strategy that is

appropriate for your solution:

Data processing post-handlerData processing post-handler  – This method is called only one time, after the ProcessRepor tProcessRepor t

method is completed and before the data set is returned to the report server. Register for this post-

handler to perform bulk updates on the temporary data set that is produced by the standard

application solution.

Temp table inser ting eventTemp table inser ting event – This method is called for each row that is added to the temporary

table. It's more suitable for calculations and inline evaluations. Try to avoid expensive queries that have

many joins and look-up operations.

Use event handlers to redirect menu items to your new repor t design.Use event handlers to redirect menu items to your new repor t design. You can customize all

aspects of an application reporting solution by using event handlers. Add a PostHandlerPostHandler  event for the

controller class to reroute user navigations to a custom report design.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/expand-app-suite-report-data-sets.md
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/extendingdatasets.png


Expand a report data set

Before (standard design)Before (standard design)

After (custom solution)After (custom solution)

The following walkthrough shows the process of expanding an existing application data set by using a "pure"

extension-based solution. The solution includes a custom Rentals listRentals list report for the Fleet Management

application. The new report includes additional rental charge data in the rental details. The application

customizations are defined in an extension model. The following illustrations show the standard design and the

custom solution.

1. Create a new model for your application customizations.Create a new model for your application customizations. For more information about extension

models, see Customize through extension and overlayering. For this example, add a custom report to the

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/fleet-extension-rentals-list-before.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/fleet-extension-rentals-list-after.png
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Fleet Management ExtensionsFleet Management Extensions  model.

2. Create a new project in Microsoft Visual Studio.Create a new project in Microsoft Visual Studio. Make sure that the project is associated with your

extension model. The following illustration shows the project settings.

3. Add a table extension to store the custom repor t data.Add a table extension to store the custom repor t data. Find the temporary cache for the

TmpFMRentalsByCustTmpFMRentalsByCust data set that is populated by the RDP class, and create an extension in your

model. Define the fields that will be used to store the data for the report server, and then click SaveSave to

save your changes. The following illustration shows the table extension that is required for this example.

4. Add your custom repor t to the project.Add your custom repor t to the project. The custom design closely resembles the standard solution.

Therefore, you can just duplicate the existing application report in the Fleet Management ExtensionFleet Management Extension

model, and then update the report design so that it includes the custom title and additional text box in the

Rental Charges container.

5. Rename the repor t so that it has a meaningful name.Rename the repor t so that it has a meaningful name. For this example, rename the custom report

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/fleet-extension-vs-project-settings.png
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class FERentalsByCustomerHandler
{
    [PostHandlerFor(classStr(FMRentalsByCustController), staticMethodStr(FMRentalsByCustController, 
construct))]
    public static void ReportNamePostHandler(XppPrePostArgs arguments)
    {
        FMRentalsByCustController controller = arguments.getReturnValue();
        controller.parmReportName(ssrsreportstr(FERentalsByCustomer, Report));
    }
}

FERentalsByCustomerFERentalsByCustomer  to distinguish it from the standard solution.

6. Restore the repor t data set references.Restore the repor t data set references. Open the report designer, expand the DatasetsDatasets  collection,

right-click the data set that is named FMRentalsByCustDSFMRentalsByCustDS , and then click RestoreRestore. The data set is

expanded so that it includes the newly introduced columns. Therefore, these columns are now available in

the report designer.

7. Customize the repor t design.Customize the repor t design. The designer offers a free-form design surface that you can use to

create the custom solution. The following illustration shows the custom design that is used for this

example.

8. Add a new repor t handler (X++) class to the project.Add a new repor t handler (X++) class to the project. Give the class a name that appropriately

describes that it's a handler for an existing application report. For this example, rename the class

FERentalsByCustomerHandlerFERentalsByCustomerHandler  to distinguish it from other report handlers.

9. Add a PostHandler method to begin to use your custom repor t.Add a PostHandler method to begin to use your custom repor t. In this example, extend the

controller class in the standard solution, FMRentalsByCustControllerFMRentalsByCustController , by using the following code.

User navigations in the application will now be rerouted to the custom reporting solution. Take some

time to deploy the custom report to the report server and verify that the application is using it. At this

point, you just have to add the business logic that is used to populate the custom fields that you

introduced in step 3. In the next step, you must select the method of data set expansion that is

appropriate for your solution.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/fleet-extension-custom-design.png
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10. Add X++ business logic to populate the custom field data.Add X++ business logic to populate the custom field data. Select the data processing technique

that makes sense for the type of transformation that you require for the solution.

class FERentalsByCustomerHandler
{
    [PostHandlerFor(classStr(FMRentalsByCustDP), methodstr(FMRentalsByCustDP, processReport))]
    public static void TmpTablePostHandler(XppPrePostArgs arguments)
    {
        FMRentalsByCustDP dpInstance = arguments.getThis() as FMRentalsByCustDP;
        TmpFMRentalsByCust tmpTable = dpInstance.getTmpFMRentalsByCust();
        FMRentalCharge chargeTable;
        ttsbegin;
        while select forUpdate tmpTable
        {
            select * from chargeTable where chargeTable.RentalId == tmpTable.RentalId;
            tmpTable.ChargeDesc = chargeTable.Description;
            tmpTable.update();
        }
        ttscommit;
    }
}

class FERentalsByCustomerHandler
{
    [DataEventHandlerAttribute(tableStr(TmpFMRentalsByCust), DataEventType::Inserting)]
    public static void TmpFMRentalsByCustInsertEvent(Common c, DataEventArgs e)
    {
        TmpFMRentalsByCust tempTable = c;
        FMRentalCharge chargeTable;
        // update the value of the 'ChargeDesc' column during 'insert' operation
        select * from chargeTable where chargeTable.RentalId == tempTable.RentalId
        && chargeTable.ChargeType == tempTable.ChargeType;
        tempTable.ChargeDesc = chargeTable.Description;
    }
}

Option 1: Add a data processing post-handler.Option 1: Add a data processing post-handler. Apply this technique for bulk insert

operations that use a single pass over the result set of the standard solution. Here is the code that

expands the data set by using a table lookup.

Option 2: Add a temp table Inser ting event.Option 2: Add a temp table Inser ting event. Apply this technique for row-by-row

calculations. Here is the code that expands the data set by using a table lookup.

You've now finished expanding the report data set. After the application is compiled, it will begin to reroute user

navigations to the new report design by using the custom X++ business logic that you defined in the report

class handler that is defined in the extension model.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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What's important to know?

Extend report menu items

This topic shows how to extend existing application menu items so that, after only minimal code changes,

navigations are redirected to a custom reporting solution.

This topic focuses on the process of extending existing application menu items so that, after only minimal code

changes, navigations are redirected to a custom reporting solution. By using this technique, you will avoid the

inconvenience of tracking down and replacing all references to an existing application report. Just extend an

existing application menu item to redirect application navigations to reports that are defined in an extension

model. The following illustration shows a typical application customization.

There are a few basic assumptions that you should be aware of before you apply this solution.

Extended menu items let you override both the display string and the target.

This technique can be used for all types of reports, from simple query-based reports to complex report data

provider (RDP)–based reports.

Extended menu items are available for direct references to reports and solutions that orchestrate the

reporting session by using a controller class.

The following walkthrough shows how to use menu item extensions to redirect user navigations in the

application to a custom solution. The solution includes a custom Customer listCustomer list report for the Fleet

Management application and defines all the application customizations in a pure extension model. The following

illustration shows the menu item that you use to access the custom Customer listCustomer list report.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/extend-report-menu-items.md
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1. Create a new model for your application customizations.Create a new model for your application customizations. For more information about extension

models, see Customize through extension and overlayering.

2. Create a new project in Microsoft Visual Studio,Create a new project in Microsoft Visual Studio, and add your custom repor t.and add your custom repor t. Additionally, add

all the solution artifacts. These artifacts include the RDP class or source query, the controller class, and UI

builders, if they are present.

3. Create an extension of the menu item that is used to access the repor t.Create an extension of the menu item that is used to access the repor t. In this example, the

output menu item is named FMCustomerListRepor tFMCustomerListRepor t. Use the menu item structure to find the menu

item name that is exposed in the application. The following illustration shows the action in Application

Explorer.

4. Modify the proper ties of the menu item extension.Modify the proper ties of the menu item extension. Update the report design or controller

reference in the menu item to direct navigations to your custom solution.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/fleet-workspace-customer-list.png
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NOTENOTE

NOTENOTE
The property changes that you can make on the object depend on the original application solution. If the

application report manages the solution by using a controller, a controller class is required for the report.

5. Rebuild the solution, and deploy the custom repor t.Rebuild the solution, and deploy the custom repor t.

You've now finished extending the report menu item. Navigations to the standard menu item will now be

redirected to your custom reporting solution.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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What's important to know?

Customize a business document

This topic shows how to create a custom report design for an existing application business document by using a

pure extension model.

Microsoft Dynamics 365 Finance includes an expanded set of tools to support custom solutions. This topic

focuses on the steps for creating a custom report design for an existing application business document by using

a pure extension model. Follow the steps later in this topic to associate a custom report design with an instance

of an application document. When you've finished, users can configure Print management settings to select the

custom design whenever it's appropriate, based on transaction details. The following illustration shows a typical

application customization.

Here are some important points that you should be aware of before you apply this solution:

Print management settings are scoped to the active legal entity. Custom designs can be associated with one

or more Print management settings.

Standard report designs continue to be available alongside custom solutions. Use Print management settings

to select the appropriate design, based on transaction details.

If you introduce a business document for a custom business process, more work is required. For more

information about how to create a custom business document solution, see the Print Management

Integration Guide.

The following walkthrough shows the process of introducing a custom report design for an existing application

business document and then using Print management to select the new design. The solution includes a custom

design definition for the Sales confirmationSales confirmation report that is provided in the standard application as part of the

Application Suite model. The application customizations will be defined in an extension model.

1. Create a new model for your application customizations.Create a new model for your application customizations. For more information about extension

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/custom-designs-business-docs.md
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/extendingprintmgt1.png
https://www.microsoft.com/download/details.aspx?id=36049


models, see Customize through extension and overlayering. For this example, you add a model that is

named Application Suite ExtensionsApplication Suite Extensions , and that references the Application Suite, Application Platform,

and Application Foundation packages.

2. Create a new project in Microsoft Visual Studio.Create a new project in Microsoft Visual Studio. Make sure that the project is associated with your

extension model. The following illustration shows the project settings.

3. Create a custom repor t design for the business document.Create a custom repor t design for the business document. You must make sure that your custom

solution consumes the correct report data contract. Find the existing Application Suite report in

Application Explorer. This report is named SalesConfirmSalesConfirm . Right-click it, and then click Duplicate inDuplicate in

projectproject to create the custom solution.

4. Rename the repor t so that it has a meaningful name.Rename the repor t so that it has a meaningful name. For this example, name the custom report

SalesConfirmExtSalesConfirmExt to distinguish it from the standard solution. Compile the project, and deploy the

report to verify that the changes have no errors.

5. Use the free-form designer to customize the repor t design.Use the free-form designer to customize the repor t design. Select the report design that is

named Repor tRepor t, right-click it, and open the precision designer. Customize the design to satisfy the

organization’s business requirements. The following illustration shows a custom design definition for the

Sales confirmationSales confirmation report.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/extensibility/customization-overlayering-extensions
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class SalesConfirmControllerExt extends SalesConfirmController
{
    public static SalesConfirmControllerExt construct()
    {
        return new SalesConfirmControllerExt();
    }
    public static void main(Args _args)
    {
        SrsReportRunController formLetterController = SalesConfirmControllerExt::construct();
        SalesConfirmControllerExt controller = formLetterController;controller.initArgs(_args, 
ssrsReportStr(SalesConfirmExt, Report));
        if (classIdGet(_args.caller()) == classNum(SalesConfirmJournalPrint))
        {
            formLetterController.renderingCompleted += 
eventhandler(SalesConfirmJournalPrint::renderingCompleted);
        }
        formLetterController.startOperation();
    }
}

6. Add a new X++ class that extends the standard repor t controller.Add a new X++ class that extends the standard repor t controller. Give the class a name that

appropriately describes that it's a handler for an existing application report. For this example, rename the

class SalesConfirmControllerExtSalesConfirmControllerExt to distinguish it from other report controllers.

7. Use the extended class to load the custom design.Use the extended class to load the custom design. Add a mainmain method that refers to the custom

report design. (You can just copy the mainmain method from the standard solution and add references to the

new ControllerController  class.) Here is the code that extends the standard solution.

8. Add a new repor t handler (X++) class to the project.Add a new repor t handler (X++) class to the project. Give the class a name that appropriately

describes that it's a handler for Print management–based documents. For this example, rename the class

Pr intMgtDocTypeHandlerExtPr intMgtDocTypeHandlerExt to distinguish it from other object handlers.

9. Add a delegate handler method to star t to use your custom repor t.Add a delegate handler method to star t to use your custom repor t. In this example, extend the

getDefaultRepor tFormatDelegategetDefaultRepor tFormatDelegate method in the Pr intMgtDocTypeHandlerExtPr intMgtDocTypeHandlerExt class by using the

following code.
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class PrintMgtDocTypeHandlersExt
{
    [SubscribesTo(classstr(PrintMgmtDocType), delegatestr(PrintMgmtDocType, 
getDefaultReportFormatDelegate))]
    public static void getDefaultReportFormatDelegate(PrintMgmtDocumentType _docType, 
EventHandlerResult _result)
    {
        switch (_docType)
        {
            case PrintMgmtDocumentType::SalesOrderConfirmation:
                 _result.result(ssrsReportStr(SalesConfirmExt, Report));
                 break;
        }
    }
}

10. Extend the menu item for the application repor t.Extend the menu item for the application repor t. Find the existing Application Suite menu item in

Application Explorer. This menu item is named SalesConfirmationSalesConfirmation. Right-click it, and then click CreateCreate

extensionextension. Open the new extension object in the designer, and set the value of the ObjectObject property to

SalesConfirmControllerExtSalesConfirmControllerExt to redirect user navigations to the extended solution.

11. Update the Pr int management settings to use the custom business document.Update the Pr int management settings to use the custom business document. For this

example, go to Accounts receivableAccounts receivable > SetupSetup > FormsForms > Form setupForm setup. Click Pr int ManagementPrint Management, find

the document configuration settings, and then select the custom design. The following illustration shows

the Print management settings after the changes have been compiled.

You’ve now finished customizing the business document. Users will now be presented with the custom report

design for the business document when they process transactions in the application.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Preprocess the data source

How do I migrate a regular RDP to a pre-process data access solution
by using TempDB?

This article provides tips that can help you prevent reports that run for a long time from timing out.

Paginated reports and documents are generated by using Microsoft SQL Server Reporting Services. Reporting

Services retrieves report data from Application Object Server (AOS) by using a custom extension that uses

Windows Communication Foundation (WCF) to communicate with AOS. The size of the data set and the

complexity of the report that is generated can affect the time that is required to display the report. Additionally,

if various time-outs and other thresholds are reached, report generation might fail. Service time-outs in

deployments are fixed and limit interactive connections to 10 minutes. Any data set generation process that

exceeds this service time-out limit won't be completed. This article describes the extensions that support long-

running reports. These extensions help guarantee that long-running reports can be generated even if the

process exceeds the 10-minute service time-out limit.

If the report uses the Report Data Provider (RDP) to retrieve data, the report should be modified to use a pre-

processed RDP class as the data source. In this way, processing logic is invoked before a call is made to

Reporting Services. For more information about RDP classes, see Using Report Data Provider Classes to Access

Report Data and Report Programming Guide.

1. Change the RDP base class from SRSRepor tDataProviderBaseSRSRepor tDataProviderBase to

SRSRepor tDataProviderPreProcessTempDBSRSRepor tDataProviderPreProcessTempDB.

2. Update the table type from InMemor yInMemor y  to TempDBTempDB.

3. Rebuild the report's RDP class.

4. Restore the data source that is linked to the RDP class in the report designer.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/prevent-long-running-reports-timing-out.md
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Use batch processing

NOTENOTE

5. Redeploy the report.

6. Introduce a ControllerController  class to run the report.

7. Update the Output Menu Item so that it points to the ControllerController  class instead of the report.

To improve performance when you print statements or reports that include large amounts of data, use batch

processing. When you use batch processing, you can run specific tasks as batch jobs and then schedule those

batch jobs to run on a different computer (a batch server). By moving the processing of these tasks to a batch

server, you can improve the report performance on the client computer. You can also apply range restrictions to

limit the size of each batch.

To further improve performance, don't submit one large batch. Instead submit multiple smaller batches for

processing at the same time on different servers. Many tasks can be run as part of batch jobs. For more

information, see Batch processing overview.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/sysadmin/batch-processing-overview
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Capabilities

Key concepts
ComponentsComponents

Data model and model mapping componentsData model and model mapping components

This topic provides an overview of the Electronic reporting (ER) tool. It includes information about key concepts,

the scenarios that ER supports, and a list of formats that have been designed and released as part of the

solution.

ER is a tool that you can use to configure formats for both incoming and outgoing electronic documents in

accordance with the legal requirements of various countries/regions. ER lets you manage these formats during

their lifecycle. For example, you can adopt new regulatory requirements, and generate business documents in

the required format to electronically exchange information with government bodies, banks, and other parties.

The ER engine is targeted at business users instead of developers. Because you configure formats instead of

code, the processes for creating and adjusting formats for electronic documents are faster and easier.

ER currently supports the TEXT, XML, Microsoft Word document, and OPENXML worksheet formats. However, an

extension interface provides support for additional formats.

The ER engine has the following capabilities:

It represents a single shared tool for electronic reporting in different domains and replaces more than 20

different engines that do some type of electronic reporting for Finance and Operations.

It makes a report's format insulated from the current implementation. In other words, the format is

applicable for different versions.

It supports the creation of a custom format that is based on an original format. It also includes capabilities for

automatically upgrading the customized format when the original format is changed because of

localization/customization requirements.

It becomes the primary standard tool to support localization requirements in electronic reporting, both for

Microsoft and for Microsoft partners.

It supports the ability to distribute formats to partners and customers through Microsoft Dynamics Lifecycle

Services (LCS).

ER supports two types of components: Data modelData model  and FormatFormat.

A data model component is an abstract representation of a data structure. It's used to describe a specific

business domain area with enough detail to satisfy the reporting requirements for that domain. A data model

component consists of the following parts:

 

 

A data model, as a set of domain-specific business entities and a hierarchically structured definition of

relations between those entities.

A model mapping that links selected application data sources to individual elements of a data model that

specifies, at run time, the data flow and rules of business data population to a data model component.

A business entity of a data model is represented as a container (record). Business entity properties are

represented as data items (fields). Each data item has a unique name, label, description, and value. The value of

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/general-electronic-reporting.md


Format components for outgoing electronic documentsFormat components for outgoing electronic documents

each data item can be designed so that it's recognized as a string, integer, real, date, enumeration, Boolean, and

so on. Additionally, it can be another record or records list.

A single data model component can contain several hierarchies of domain-specific business entities. It can also

contain model mappings that support a report-specific data flow at run time. The hierarchies are differentiated

by a single record that has been selected as a root for model mapping. For example, the data model of the

payment domain area might support the following mappings:

Company > Vendor > Payment transactions of the AP domain

Customer > Company > Payment transactions of the AR domain

Note that business entities such as company and payment transactions are designed one time. Different

mappings then reuse them.

A model mapping that supports outgoing electronic documents has the following capabilities:

It can use different data types as data sources for a data model. For example, it can use tables, data entities,

methods, or enums.

It supports user input parameters that can be defined as data sources for a data model when some data must

be specified at run time.

It supports the transformation of data into required groups. It also lets you filter, sort, and sum data, and

append logical calculated fields that are designed through formulas that resemble Microsoft Excel formulas.

For more information, see Formula designer in Electronic reporting (ER)).

A model mapping that supports incoming electronic documents has the following capabilities:

It can use different updatable data elements as targets. These data elements include tables, data entities, and

views. The data can be updated by using the data from incoming electronic documents. Multiple targets can

be used in a single model mapping.

It supports user input parameters that can be defined as data sources for a data model when some data must

be specified at run time.

A data model component is designed for each business domain that should be used as a unified data source for

reporting that isolates reporting from the physical implementation of data sources. It represents domain-

specific business concepts and functionalities in a form that makes a reporting format's initial design and

further maintenance more efficient.

A format component is the scheme of the reporting output that will be generated at run time. A scheme consists

of the following elements:

A format that defines the structure and content of the outgoing electronic document that is generated at run

time.

Data sources, as a set of user input parameters and a domain-specific data model that uses a selected model

mapping.

A format mapping, as a set of bindings of format data sources that have individual elements of a format that

specify, at run time, the data flow and rules for format output generation.

A format validation, as a set of configurable rules that control report generation at run time, depending on

the running context. For example, there might be a rule that stops output generation of a vendor's payments

and throws an exception when specific attributes of the selected vendor are missing, such as the bank

account number.

A format component supports the following functions:

Creation of reporting output as individual files in various formats, such as text, XML, Microsoft Word

document, or worksheet.



Format components for incoming electronic documentsFormat components for incoming electronic documents

Creation of multiple files separately and encapsulation of those files into zip files.

A format component lets you attach specific files that can be used in the reporting output:

Excel workbooks that contain a worksheet that can be used as a template for output in the OPENXML

worksheet format

Word files that contain a document that can be used as a template for output in the Microsoft Word

document format

Other files that can be incorporated into the format's output as predefined files

The following illustration shows how the data flows for these formats.

To run a single ER format configuration and generate an outgoing electronic document, you must identify the

mapping of the format configuration.

A format component is the scheme of the incoming document that is imported at run time. A scheme consists of

the following elements:

A format that defines the structure and content of the incoming electronic document that contains data that

is imported at run time. A format component is used to parse an incoming document in various formats,

such as text and XML.

A format mapping that binds individual format elements to elements of a domain-specific data model. At run

time, the elements in the data model specify the data flow and the rules for importing data from an incoming

document, and then store the data in a data model.

A format validation, as a set of configurable rules that control data import at run time, depending on the

running context. For example, there might be a rule that stops data import of a bank statement that has a

vendor's payments and throws an exception when a specific vendor's attributes are missing, such as the

vendor identification code.

The following illustration shows how the data flows for these formats.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er-overview-02.png


  Component versioningComponent versioning

Component date effectivityComponent date effectivity

Component accessComponent access

To run a single ER format configuration to import data from an incoming electronic document, you must identify

the desired mapping of a format configuration, and also the integration point of a model mapping. You can use

the same model mapping and destinations together with different formats for different type of incoming

documents.

Versioning is supported for ER components. The following workflow is provided to manage changes in ER

components:

1. The version that is originally created is marked as a DraftDraft version. This version can be edited and is available

for test runs.

2. The DraftDraft version can be converted to a CompletedCompleted version. This version can be used in local reporting

processes.

3. The CompletedCompleted version can be converted to a SharedShared version. This version is published on LCS and can be

used in global reporting processes.

4. The SharedShared version can be converted to a DiscontinuedDiscontinued version. This version can then be deleted.

Versions that have either CompletedCompleted or SharedShared status are available for other data interchange. The following

actions can be performed on a component that has these statuses:

The component can be serialized in XML format and exported as a file in XML format.

The component can be reserialized from an XML file and imported into the application as a new version of an

ER component.

ER component versions are date-effective. You can set the Effective fromEffective from date for an ER component to specify

the date that the component becomes effective for reporting processes. The application session date is used to

define whether a component is valid for execution. If more than one version is valid for a particular date, the

latest version is used for reporting processes.

Access to ER format components depends on the setting for the ISO country/region code. When this setting is

blank for a selected version of a format configuration, a format component can be accessed from any company

at run time. When this setting contains ISO country/region codes, a format component is available only from

companies that have a primary address that is defined for one of a format component's ISO country/region

codes.

Different versions of a data format component can have different settings for ISO country/region codes.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er-overview-03.png


ConfigurationConfiguration

ProviderProvider

RepositoryRepository

An ER configuration is the wrapper of a particular ER component. That component can be either a data model

component or a format component. A configuration can include different versions of an ER component. Each

configuration is marked as owned by a specific configuration provider. The DraftDraft version of a component of a

configuration can be edited when the owner of the configuration has been selected as an active provider in the

ER settings in the application.

Each model configuration contains a data model component. A new format configuration can be derived from a

specific data model configuration. In the configuration tree, the format configuration that is created appears as a

child of the original data model configuration.

The format configuration that is created contains a format component. The data model component of the

original model configuration is automatically inserted into the format component of the child format

configuration as a default data source.

An ER configuration is shared for application companies.

The ER provider is the party identifier that is used to indicate the author (owner) of each ER configuration. ER

lets you manage the list of configuration providers. Format configurations that are released for electronic

documents as part of the Finance and Operations solution are marked as owned by the MicrosoftMicrosoft

configuration provider.

To learn how to register a new ER provider, play the task guide, ER Create a configuration provider andER Create a configuration provider and

mark it as activemark it as active (part of the 7.5 .4 .3 Acquire/Develop IT ser vice/solution components (10677)7.5 .4 .3 Acquire/Develop IT ser vice/solution components (10677)

business process).

An ER repository stores ER configurations. The following types of ER repositories are currently supported:

LCS shared library

LCS project

File system

RCS

Operations resources

Global repository

An LCS shared librar yLCS shared librar y  repository provides access to the list of configurations within the Shared asset library

in Lifecycle Services (LCS). This type of ER repository can only be registered for the Microsoft provider. From the

LCS Shared asset library you can import the latest versions of ER configurations into the current instance.

An LCS projectLCS project repository provides access to the list of configurations of a specific LCS project (LCS project

assets library) that was selected when the repository was registered. ER lets you upload shared configurations

from the current instance to a specific LCS projectLCS project repository. You can also import configurations from an LCSLCS

projectproject repository into the current instance of your Finance and Operations apps.

A File systemFile system repository provides access to the list of configurations that are located as xml files in the specific

folder of the local file system of the machine where the AOS service is hosted. Required folder is selected at the

repository registration stage. You can import configurations from a File systemFile system repository into the current

instance.

Note that this repository type is accessible in the following environments:

Cloud-hosted environments deployed for development purposes (containing test models of enclosed suites)

Locally deployed environments (on-premises)

For more information, see Import Electronic reporting (ER) configurations.



Supported scenarios
Building a data modelBuilding a data model

Translating data model contentTranslating data model content

Configuring data model mappings for outgoing documentsConfiguring data model mappings for outgoing documents

Configuring data model mappings for incoming documentsConfiguring data model mappings for incoming documents

An RCSRCS  repository provides access to the list of configurations of a specific instance of Configuration service

(RCS) that was selected at the repository registration stage. ER lets you import completed or shared

configurations from the selected RCS instance into the current instance so you can use them for electronic

reporting.

For more information, see Import Electronic reporting (ER) configurations from RCS.

A Global repositor yGlobal repositor y  repository provides access to the list of configurations within the global repository in the

Configuration service. This type of ER repository can only be registered for the Microsoft provider. From the

global repository, you can import the latest versions of ER configurations into the current instance.

For more information, see Import Electronic reporting (ER) configurations from Global repository of

Configuration service.

An Operations resourcesOperations resources  repository provides access to the list of configurations that Microsoft, as an ER

configuration provider, initially releases as part of the application solution. These configurations can be

imported into the current instance and used for electronic reporting or playing sample task guides. They can

also be used for additional localizations and customizations. Note that the latest versions provided by Microsoft

ER configurations must be imported from the LCS Shared asset library by using corresponding the ER

repository.

Required LCS projectLCS project, File systemFile system, and Regulator y Configuration Ser vices (RCS)Regulator y Configuration Ser vices (RCS)  repositories can be

registered individually for each configuration provider of the current instance. Each repository can be dedicated

to a specific configuration provider.

ER provides a model designer that you can use to build a data model for a particular business domain. All

domain-specific business entities, and the relations between them, can be presented in a data model as a

hierarchical structure.

To become familiar with the details of this scenario, play the ER Design domain specific data modelER Design domain specific data model  task

guide (part of the 7.5 .4 .3 Acquire/Develop IT ser vice/solution components (10677)7.5 .4 .3 Acquire/Develop IT ser vice/solution components (10677)  business process).

Data model content (labels and descriptions) can be translated into other languages that the applications

support. You might want to translate data model content for the following reasons:

At design time, to make the content more intelligible for format designers who speak other languages, and

who will use the data model for data mapping of format components.

At run time, to make the content more user-friendly by presenting prompts and help for run-time

parameters, and configured validation messages (errors and warnings), in the language that the currently

signed-in user prefers.

ER provides a model mapping designer that lets users map data models that they have designed to specific

application data sources. Based on the mapping, the data will be imported at run time from selected data

sources into the data model. The data model is then used as an abstract data source of ER formats that generate

outgoing electronic documents.

To become familiar with the details of this scenario, play the ER Define model mapping and select dataER Define model mapping and select data

sourcessources  and ER Map data model to selected data sourcesER Map data model to selected data sources  task guides (part of the 7.5 .4 .37.5 .4 .3

Acquire/Develop IT ser vice/solution components (10677)Acquire/Develop IT ser vice/solution components (10677)  business process).

https://docs.microsoft.com/en-us/business-applications-release-notes/october18/dynamics365-finance-operations/regulatory-service-configuration
https://docs.microsoft.com/en-us/business-applications-release-notes/october18/dynamics365-finance-operations/regulatory-service-configuration
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/er-download-configurations-global-repo


Storing a designed model component as a model configurationStoring a designed model component as a model configuration

Building a format that uses a data model as a baseBuilding a format that uses a data model as a base

Building a configuration to generate electronic documents in OPENXML worksheet formatBuilding a configuration to generate electronic documents in OPENXML worksheet format

Building a configuration to generate electronic documents in a Word document formatBuilding a configuration to generate electronic documents in a Word document format

Building a configuration to import data from incoming electronic documentsBuilding a configuration to import data from incoming electronic documents

ER provides a model mapping designer that lets users map data models that they have designed to specific

destinations. For example, data models can be mapped to the updatable data components (tables, data entities,

and views). Based on the mapping, the data will be updated at run time by using the data from the data model.

As abstract storage of the ER format, the data model is filled with data that is imported from an incoming

electronic document.

ER can store a designed data model, together with associated data mappings, as a model configuration of the

current instance. The following illustration shows an example of this type of data model configuration (the

payment model configuration).

To become familiar with the details of this scenario, play the ER Map data model to selected data sourcesER Map data model to selected data sources

task guide (part of the 7.5 .4 .3 Acquire/Develop IT ser vice/solution components (10677)7.5 .4 .3 Acquire/Develop IT ser vice/solution components (10677)  business

process).

ER supports a format designer that you can use to build the format of an electronic document for a selected

business domain by selecting the model component as a base. The same ER format designer lets you map a

format that you create to a selected domain's data model mapping as a data source.

To become familiar with the details of this scenario, play the ER Design domain specific formatER Design domain specific format task guide

(part of the 7.5 .4 .3 Acquire/Develop IT ser vice/solution components (10677)7.5 .4 .3 Acquire/Develop IT ser vice/solution components (10677)  business process).

The ER format designer can be used to build an electronic document in OPENXML worksheet format.

To become familiar with the details of this scenario, play the ER Create a configuration for repor ts inER Create a configuration for repor ts in

OPENXML formatOPENXML format task guide (part of the 7.5 .4 .3 Acquire/Develop IT ser vice/solution components7.5 .4 .3 Acquire/Develop IT ser vice/solution components

(10677)(10677)  business process). As part of the task guide step for importing a template, use the Template of

Payment Report (SampleVendPaymWsReport.xlsx) Excel file as a template.

The ER format designer can be used to build an electronic document in a Word document format. The following

illustration shows an example of this type of format. Note that this format reuses the existing ER configuration

that was originally designed to generate the report output in OPENXML format.

To become familiar with the details of this scenario, play the ER Design a configuration for generating reports in

Microsoft WORD format task guide (part of the 7.5.4.3 Acquire/Develop IT service/solution components (10677)

business process). As part of the task guide step for importing a template, use the following Word files as

templates for the ER format:

Template of Payment Report (SampleVendPaymDocReport.docx)

Bounded template of Payment Report (SampleVendPaymDocReportBounded.docx)

The ER format designer can be used to describe an electronic document that is planned for data import in either

XML or text format. The designed format is used to parse an incoming document. The ER format mapping

designer can be used to define the binding of the elements of the designed format to the data model.

To become familiar with the details of this scenario, play the Create required ER configurations to import data

from an external file task guide (part of the 7.5.4.3 Acquire/Develop IT service/solution components (10677)

business process). Use the following files to play this guide:

ER data model configuration (1099model.xml)

ER format configuration (1099format.xml)

Sample of the incoming document in XML format (1099entries.xml)

https://go.microsoft.com/fwlink/?linkid=845202
https://go.microsoft.com/fwlink/?linkid=845202
https://go.microsoft.com/fwlink/?linkid=845202
https://go.microsoft.com/fwlink/?linkid=845202
https://go.microsoft.com/fwlink/?linkid=845202
https://go.microsoft.com/fwlink/?linkid=845202


  

Storing a designed format component in a format configurationStoring a designed format component in a format configuration

Configuring Finance to start to use a created format internallyConfiguring Finance to start to use a created format internally

Handling ER components
Publishing an ER component in LCS to offer it externally (localization)Publishing an ER component in LCS to offer it externally (localization)

Importing an ER component from LCS to use it internallyImporting an ER component from LCS to use it internally

Building a format selecting another format as a base (customization)Building a format selecting another format as a base (customization)

Upgrading a format selecting a new version of base format (rebase)Upgrading a format selecting a new version of base format (rebase)

Sample of the workbook to manage data of incoming document (1099entries.xlsx)

ER can store a designed format together with the configured data mappings as a format configuration of the

current instance. The preceding illustration shows an example of this type of format configuration (BACS (UK)BACS (UK) ,

which is a child of the Payment modelPayment model  configuration). To become familiar with the details of this scenario, play

the ER Design domain specific formatER Design domain specific format task guide (part of the 7.5 .4 .3 Acquire/Develop IT7.5 .4 .3 Acquire/Develop IT

ser vice/solution components (10677)ser vice/solution components (10677)  business process).

The application can be configured to start to use a created format to generate electronic reports. The reference

to the created format configuration should be defined in the settings of a specific domain. For example, to start

to use an ER format configuration for electronic vendor payments in BACS format, the format configuration

should be referenced in specific methods of payment.

To become familiar with the details of this scenario, play the ER Use format to generate electronicER Use format to generate electronic

document for paymentsdocument for payments  task guide (part of the 7.5 .4 .3 Acquire/Develop IT ser vice/solution7.5.4 .3 Acquire/Develop IT ser vice/solution

components (10677)components (10677)  business process).

The owner of a component (model or format) that has been created can use ER to publish the completed version

of the component to LCS. A repository of the LCS projectLCS project type for the current ER configuration provider is

required. When the status of the completed version of a component is changed from COMPLETEDCOMPLETED to SHAREDSHARED,

that version is published in LCS. When a component has been published to LCS, the owner of that component

becomes a provider of the service to support the component. For example, if the format component is designed

to generate an electronic document that is legally required (for example, in accordance with a localization

scenario), it's assumed that the format will be kept compliant with legislative changes, and that the provider will

issue new versions of the component whenever new legislative requirements arise. To become familiar with the

details of this scenario, play the ER Upload a configuration into L ifecycle Ser vicesER Upload a configuration into L ifecycle Ser vices  task guide (part of the

7.5.4 .3 Acquire/Develop IT ser vice/solution components (10677)7.5 .4 .3 Acquire/Develop IT ser vice/solution components (10677)  business process).

ER lets you import ER components from LCS to the current instance. A repository of the LCS projectLCS project type is

required. When an ER component has been imported from LCS to the current instance, the owner of the

instance becomes a consumer of the service that is provided by the owner (author) of the imported component.

For example, if a format component is designed to generate a specific electronic document from the application

in a country/region-specific format (localization scenario), it's assumed that the service consumer will be able to

obtain any updates that are made to that format, to keep it compliant with legislative requirements. To become

familiar with the details of this scenario, play the ER Impor t a configuration from Lifecycle Ser vicesER Impor t a configuration from Lifecycle Ser vices  task

guide (part of the 7.5 .4 .3 Acquire/Develop IT ser vice/solution components (10677)7.5 .4 .3 Acquire/Develop IT ser vice/solution components (10677)  business process).

ER lets you create (derive) a new component from the current version of a component (base) that was imported

from LCS. For example, a user wants to derive a new format to implement some special requirements for an

electronic document (such as an additional field or an extensive description) to support a customization

scenario. To become familiar with the details of this scenario, play the ER Upgrade format by adoption ofER Upgrade format by adoption of

new base version of itnew base version of it task guide (part of the 7.5 .4 .3 Acquire/Develop IT ser vice/solution components7.5 .4 .3 Acquire/Develop IT ser vice/solution components

(10677)(10677)  business process).

ER lets you automatically adopt changes of the latest version of the base component in the current draft version

https://go.microsoft.com/fwlink/?linkid=845202


 List of ER configurations that have been released in Finance

Additional resources

NOTENOTE

of the derived component. This process is known as rebasing. For example, a new regulatory change that has

been introduced in the latest version of the format that was imported from LCS can be automatically merged

into the customized version of this format of the electronic document. Any changes that can't be merged

automatically are considered conflicts. These conflicts are presented for manual resolution in the designer tool

for the appropriate component. To become familiar with the details of this scenario, play the ER UpgradeER Upgrade

format by adoption of new base version of that formatformat by adoption of new base version of that format task guide (part of the 7.5 .5 .37.5 .5 .3

Acquire/Develop changed IT ser vice/solution component (10683)Acquire/Develop changed IT ser vice/solution component (10683)  business process).

The list of ER configurations for Finance is constantly updated. Open the Global repository to review the list of

ER configurations that are currently supported. On the Discontinuation detailsDiscontinuation details  FastTab, you can review the

information about configurations that have been discontinued or that are no longer being maintained.

Create Electronic reporting (ER) configurations

Manage the Electronic reporting (ER) configuration lifecycle

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/er-download-configurations-global-repo
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Electronic reporting

Configuration instead of codingConfiguration instead of coding

One configuration for multiple Dynamics 365 Finance releasesOne configuration for multiple Dynamics 365 Finance releases

Easy or automatic upgradeEasy or automatic upgrade

What's new here

As part of the requirements for LCS solutions for localization and translation, localization ISV solution providers

must implement country/region-specific or solution-specific features by using the Electronic reporting tool. This

article provides background information that will help you start to use Electronic reporting to create

configurations. This article isn't meant to replace any available and upcoming Electronic reporting

documentation, but is intended as a supplemental view from the perspective of localization requirements.

General electronic reporting (GER) is a new configurable tool that helps you create and maintain regulatory

electronic reporting and payments, based on the following three concepts.

Configuration can be done by a business user and doesn't require a developer.

The data model is defined in business terms.

Visual editors are used to author all components of the GER configuration.

A Microsoft Excel–like formula language is used for data transformation.

Manage one domain specific data model that is defined in business terms.

Isolate application release specifics in release-dependent data model mappings.

Maintain one format configuration for multiple releases of the current version, based on the data model.

Versioning of GER configurations is supported.

The Microsoft Dynamics Lifecycle Services (LCS) Assets library can be used as a repository for GER

configurations for version exchange.

Localizations that are based on origin GER configurations can be introduced as child versions.

A GER configuration tree is provided as a tool that helps control dependencies for versions.

Only differences in localization (delta configuration) are recorded to enable automatic upgrade to a new

version of the origin GER configuration.

It's easy to manually resolve conflicts that are discovered during automatic upgrade of localization versions.

GER lets users define electronic format structures, and then describe how those structures should be filled by

using data and algorithms. Users can use a formula language that is very similar to the Excel language for data

transformation. To make the database-to-format mapping more manageable, reusable, and independent of

format changes, an intermediate data model concept is introduced. This concept enables implementation details

to be hidden from the format mapping and also enables a single data model to be reused for multiple format

mappings.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/electronic-reporting-configuration.md
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Configure and generate
electronic documents to
meet the legal requirements
in various countries/regions.

Electronic documents are
hard-coded in X++ or as
Extensible Stylesheet
Language Transformations
(XSLTs).

GER is a new tool for
configuring and generating
electronic documents that
target a business user
instead of a developer.

GER simplifies the creation,
maintenance, and upgrade
of electronic document
formats to meet legal
requirements in various
countries/regions.

Configure regulatory
updates to formats.

Any format adjustments
require development effort.

A business user can
configure the formats,
based on domain-specific
data models (for example,
for payments, Intrastat
reports, or tax reports).

GER makes the process of
creating or changing
electronic document
formats faster and easier.
These changes can be made
by business users instead of
developers.

Separation of data and
formats makes updates
easier.

Access to data and access
to formatting aren't
isolated.

GER lets you set up data
models that are domain-
specific and independent of
the database as data
sources for document
formats. Formats can be
configured based on these
domain-specific data
models by using simple
visual tools that are similar
to Excel. Data models and
formats support versioning,
and formats can be date-
effective.

GER makes it faster and
easier for partners and
customers to upgrade their
format and customizations
to new versions of formats
that are released by
Microsoft or other partners.

Distribute data models and
formats.

An adjusted format
deployment requires a new
hotfix package that
overrides the existing
format.

Each data model or format
version is stored in a
separate configuration, and
is distributed to partners
and customers through
LCS. By using LCS, partners
can share their data model
and format configurations
with other partners and
customers, who can
customize and share them
further.

GER provides one common
way (through LCS) for
Microsoft and partners to
distribute electronic
document configurations to
other partners and
customers. GER also makes
it easier for partners and
customers to customize,
upgrade, and distribute
electronic document
formats for their specific
business requirements.

Customization and upgrade
are easier.

Custom modification of
each format must be
manually ported to the
source code of a new hotfix
package.

Partners and customers can
customize Microsoft data
models and formats, or
create their own. GER saves
partner and customer
configuration changes as
deltas to Microsoft
configurations to simplify
upgrades to new versions
of Microsoft configurations.
Delta customization and
easy upgrade are
supported through the
whole customization chain.

GER provides one common
way (through LCS) for
Microsoft and partners to
distribute electronic
document configurations to
other partners and
customers. GER also makes
it easier for partners and
customers to customize,
upgrade, and distribute
electronic document
formats for their specific
business requirements.



Basic concepts
Main data flowMain data flow

Data model configuration creationData model configuration creation

Design the data model of the created model configurationDesign the data model of the created model configuration

Format configuration creationFormat configuration creation

It's a good idea to reuse and customize data models that are released by Microsoft whenever you can, or to

create a business domain area–specific data model that will introduce the abstract model of required entities

and their relations. In this way, you will be aligned with future updates that are released by Microsoft, or can at

least reuse your model for the design and maintenance of multiple domain–specific electronic documents that

have different formats that are required in different scenarios or countries/regions.

A data model is designed to recognize and describe the required business entities and the relations between

them in the selected domain. A data model consists of descriptors that express entities by using data containers

(records). Properties of entities are expressed by using data items. A record definition is an entity that contains

fields (the data items). Each data item has a unique name, label, description, and value. The value of each data

item can be designed so that it's recognized as string, integer, real, date, enumerate type, and so on. Additionally,

the value can be another record or record list. A single record definition can be selected as a root of the data

model. (A root is the starting point of the entire model for data source mapping.) In this case, the model is used

as a data source that delivers data according to the single predefined data flow. If no record definition was

selected as a root of the data model, the data model contains record definitions that can be assigned as a root at

the format mapping stage. The data flow of such a model can be defined as a data source in multiple ways,

depending on the nature of the format. For example, a single data model can be designed for the payments

domain area. This data model can include data record definitions for the company as a legal entity, for vendors

and customers, and also for payments. However, according to the nature of the format, the data must be

presented in the following way: payer > payee > payments. Therefore, a single data model can offer data

according to the following alternative paths:

Company > vendor > payment for the Accounts payable domain when the company record definition is

selected as a root.

Customer > company > payment for the Accounts receivable domain when the customer record definition is

selected as a root.

You use the data model configuration that is created to hold abstract data for a new electronic format that you

want to design. If you intend to consume a data model that was prepared earlier when you create a new format,

make sure that you select the Format based on data modelFormat based on data model  option for Create configurationCreate configuration. After you a

have a format configuration, you must define a format structure. The structure can be created manually or

automatically by importing an example of an XML file or an Excel template. The data model of the parent

configuration is automatically offered for format mapping, together with a proper root container. Nevertheless,

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ger-main-data-flow.jpg
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Version control

NOTENOTE

Electronic reporting domain coverage

a format might require that data be represented in a specific way. Therefore, you can use formula designer to

define expressions as virtual data items (calculated fields) for our data containers.

Although GER allows for direct mapping of format components to database artifacts (tables or data entities), we don't

recommend this approach, because it's likely that multiple formats will be maintained in some business domain areas that

use the same data sources. Whenever the structure of such database artifacts is changed, the format mapping to the

database artifacts must also be changed, and the cost of these changes will be multiplied by the number of maintained

formats. Therefore, we recommend that you work through the data model as the abstract description of the domain-

specific data structure, and that you use the direct binding of format elements to database components only for

simplification and for coverage for specific customizations (for example, to refer to custom tables when these references

are required in a limited number of maintained formats).

One of the principles behind the design of Electronic reporting is that it should be easy to distribute a data

model and formats together with an enhanced maintenance model for their customizations. All the

configurations are versioned, and an existing customization can be "cloned" to derive a new configuration for

localization or customization implementation. For example, we represent a company that is named Proseware,

Inc. We have subscribed to the service of a company that is named Litware Inc., which provides us with the

Intrastat returns configuration and supports all legal requirements in it. We have already received specific

configurations, from Litware Inc., together with data model and formats, and have deployed them. Our company

is working in a district where, in addition to the federal requirements, we must support the following regional

requirements:

As part of Intrastat transactions details, our XML file must show the statistical procedure code that isn't

required anywhere else.

We must limit the length of the company name that is presented in the Intrastat returns header block to 200

characters.

To support these requirements and comply with local district authorities, we must implement this localization as

a localized configuration. However, we must keep the link with the origin configuration, so that we can adopt any

future changes that are introduced at the federal level as new versions of the origin configuration. Therefore, we

import the Litware Inc. origin configuration from LCS, derive it as a new localized configuration, introduce the

required changes, complete this work by introducing a first version of the localized format, and start to use it

internally. Whenever Litware Inc. offers us a new version of the origin configuration, we import it from LCS,

rebase our localized configuration to this version, adopt changes to support new federal requirements, complete

this work by introducing a next version of the localized format, and continue to use it internally.

The draft version of any configuration must be "completed" before it can become available locally for further action, such

as the following:

Make it available so that it can be referenced as a data source from a new format.

Enable configuration exchange between companies or instances via configuration import/export, and so on.

Several out-of-box configurations can be used to meet electronic reporting requirements for specific

countries/regions. The following list show some examples of format configurations that are grouped into

business domains. To get a complete, up-to-date list of available and supported configurations, open a
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configuration repository setup to show the configurations that are available for import from either resources or

an LCS Assets library.

Audit file

FEC

GDPdU...

Payments (ISO20022)

SEPA CT

SEPA DD

JBA

BACS...

Statistical reports

EU Intrastat...

Tax reports

CIS

BAS

ELSTER

EU Sales list...

Customer e-Invoice

OIOUBL...

You can choose how to move your electronic reporting functionality into GER. However, you should consider the

following high-level steps when you plan that move.

1. Review the electronic reporting functionality that your solution currently provides.

2. Identify domain areas that your solution covers, such as Payments and E-Invoices.

3. Review the configurations that are provided by Microsoft. It's likely that you'll find a configuration that you

can use as a base. For example, if your solution customizes the SEPA CT payment format, you should extend

the SEPA CT configuration.

4. Create new configurations that are based on either an existing model or format, or a new model or format.

5. Define input parameters that users must select when they run the report, and validations for the content of

the report.

6. Define mappings with the model by using arithmetic, string, data, or other available Excel-like functions.

7. Define labels and translation to different languages, where applicable.

8. Define templates that have named ranges, and set links from the configuration for the Excel report, if

applicable.



GER Electronic reporting is an engine that simplifies the creation
of electronic reports for information interchange with
governments, banks, and other parties. Currently, Electronic
reporting supports text, XML, and OpenXML spreadsheet
formats, and provides an extension interface to support
more formats.

Transformation If you have a typical action that must be done on the source
of data before it is sent as output to a format, you can
introduce a transformation and attach it to format
components. Transformation is a GER formula that takes one
value as a parameter and returns another value. For
example, you have many format fields that contain spaces,
and the spaces should be replaced by spaces when the fields
are exported. In this case, you can create a transformation
that takes a string argument and uses the REPLACE function
to do the job. You can then create string components and
associate them with that transformation.

Data model A data model provides a structure for data. This structure is
used to abstractly describe certain business domain areas at
sufficient detail to satisfy the reporting requirements in this
domain.

Configuration A container for either a data model or a format, together
with its mappings to data sources, that can be maintained
and executed, and that supports versioning. The
configuration is the entity that will be imported or exported
to organize electronic document format exchange between
Finance and Operations instances.

Derive action An operation that uses a configuration that already exists as
a basis to create a new configuration.

Rebase action An operation that updates a derived configuration with
changes that were introduced in a new version of the base
configuration. The version number is selected at the rebase
initialization stage.

Update conflict A conflict that is discovered during the rebase action, where
the new base version contains adjustments of a
format/mapping element (name, property, and so on) that
has also been adjusted in the derived version.

Relocation conflict A conflict that is discovered during the rebase action, where
the new base version contains a new position (parent
element) of a format element (name, property, and so on)
that has also been relocated to a different position in the
derived version.

Duplication conflict A conflict that is discovered during the rebase action, where
the new base version introduced a new format element that
is the same as an element (in other word, it has the same
name and child components) that has also been entered in
the derived version.
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Additional resources
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Electronic reporting (ER) overview

Manage the Electronic reporting (ER) configuration lifecycle

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


ER Design domain specific data model
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Create a new data model configuration

Create a data model

Define the structure of a party participating in a payment process

The following steps explain how a user in the System Administrator or Electronic Reporting Developer role can

create a new Electronic reporting (ER) configuration that contains a data model for electronic payment

documents. This data model will later be used as a data source when you create the format of the payment

documents.

In this example, you will create a configuration for sample company, Litware, Inc. These steps can be performed

in any company as ER configurations are shared among companies. To complete these steps, you must first

complete the steps in the "Create a configuration provider and mark it as active" procedure.

1. Go to Organization administration > Workspaces > Electronic reporting.

Select the configuration provider for sample company, 'Litware, Inc.' If you don't see this configuration

provider, you must first complete the steps in the "Create a configuration provider and mark it as active"

procedure.

2. Click Reporting configurations.

You will create a configuration that contains a data model for electronic payment documents. This data

model will be used later as a data source when you create the format for the payment documents.

1. Click Create configuration to open the drop dialog.

2. In the Name field, type 'Payments (simplified model)'.

3. In the Description field, type 'Payment model configuration'.

The active configuration provider is automatically entered here. This provider will be able to maintain this

configuration. Other providers can use this configuration, but will not be able to maintain it.

4. Click 'Create configuration' button to complete the configuration creation task

You're creating a new data model for the selected configuration. This configuration version will have a status of

Draft.

1. Click Designer.

1. Click New to open the drop dialog.

2. In the Name field, type 'Party'.

3. Click Add.

4. Click New to open the drop dialog.

5. In the Name field, type 'Name'.

6. In the Item type field, select 'String'.

7. Click Add.

8. In the Find field, type 'Party'.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-design-domain-specific-data-model-2016-11.md


Define the bank structure for this model

Define the bank account structure for this model

9. Click Find previous.

1. Click New to open the drop dialog.

2. In the Name field, type 'Agent'.

3. In the Item type field, select 'Record'.

4. Click Add.

5. In the Description field, enter 'Financial institution (for instance, a bank) servicing an account for the party

(debtor/creditor).'.

Financial institution (for instance, a bank) servicing an account for the party (debtor/creditor).

6. Click New to open the drop dialog.

7. In the Name field, type 'Name'.

8. In the Item type field, select 'String'.

9. Click Add.

10. Click New to open the drop dialog.

11. In the Name field, type 'SWIFT'.

12. Click Add.

13. In the Description field, enter 'Bank identification code'.

14. Click New to open the drop dialog.

15. In the Name field, type 'RoutingNumber'.

16. Click Add.

17. In the Description field, enter 'Routing number'.

18. Click Find previous.

1. Click New to open the drop dialog.

2. In the Name field, type 'Account'.

3. In the Item type field, select 'Record'.

4. Click Add.

5. In the Description field, enter 'Identification of an account of a party in a financial institution (for instance,

a bank).'.

Identification of an account of a party in a financial institution (for instance, a bank).

6. Click New to open the drop dialog.

7. In the Name field, type 'Currency'.

8. In the Item type field, select 'String'.



Define the payment message structure for credit transfer payment
type

9. Click Add.

10. In the Description field, enter 'Currency code'.

11. Click New to open the drop dialog.

12. In the Name field, type 'Number'.

13. Click Add.

14. Click New to open the drop dialog.

15. In the Name field, type 'IBAN'.

16. Click Add.

17. In the Description field, enter 'International bank account number'.

1. Click New to open the drop dialog.

2. In the New node as a field, enter 'Model root'.

3. In the Name field, type 'CustomerCreditTransferInitiation'.

4. Click Add.

5. In the Find field, type 'CustomerCreditTransferInitiation'.

6. Click Find previous.

7. Click New to open the drop dialog.

8. In the Name field, type 'MessageIdentification'.

9. Click Add.

10. In the Description field, enter 'The point-to-point reference assigned by the instructing party (and sent to

the next party) to identify a message.'.

The point-to-point reference assigned by the instructing party (and sent to the next party) to identify a

message.

11. Click New to open the drop dialog.

12. In the Name field, type 'ProcessingDateTime'.

13. In the Item type field, select 'DateTime'.

14. Click Add.

15. In the Description field, enter 'Date and time at which the payment message was created.'.

16. Click New to open the drop dialog.

Define the payment transaction structure for this model.

17. In the Name field, type 'Payments'.

18. In the Item type field, select 'Record list'.

19. Click Add.



20. In the Description field, enter 'Payment lines of the current message'.

21. Click New to open the drop dialog.

22. In the Name field, type 'Creditor'.

23. In the Item type field, select 'Record'.

24. Click Add.

25. In the Description field, enter 'Party to which an amount of money is due.'.

26. Click Switch item reference.

27. In the Find field, type 'Party'.

28. Click Find next.

29. Click OK.

30. In the Find field, type 'Payments'.

31. Click Find next.

32. Click New to open the drop dialog.

33. In the Name field, type 'Debtor'.

34. Click Add.

35. In the Description field, enter 'Party that owes an amount of money to the (ultimate) creditor.'.

36. Click Switch item reference.

37. In the Find field, type 'Party'.

38. Click Find next.

39. Click OK.

40. Click Find next.

41. Click New to open the drop dialog.

42. In the Name field, type 'Description'.

43. In the Item type field, select 'String'.

44. Click Add.

45. Click New to open the drop dialog.

46. In the Name field, type 'Currency'.

47. Click Add.

48. In the Description field, enter 'Currency code'.

49. Click New to open the drop dialog.

50. In the Name field, type 'TransactionDate'.

51. In the Item type field, select 'Date'.

52. Click Add.
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53. In the Description field, enter 'Transaction date'.

54. Click New to open the drop dialog.

55. In the Name field, type 'InstructedAmount'.

56. In the Item type field, select 'Real'.

57. Click Add.

58. In the Description field, enter 'The amount of money to be moved between the debtor and creditor, before

deduction of charges. The amount should be expressed in the currency as ordered by the initiating party.'.

The amount of money to be moved between the debtor and creditor, before deduction of charges. The

amount should be expressed in the currency as ordered by the initiating party.

59. Click New to open the drop dialog.

60. In the Name field, type 'End2EndID'.

61. In the Item type field, select 'String'.

62. Click Add.

63. In the Description field, enter 'The unique identification assigned by the initiating party. This identification

is passed on, unchanged, throughout the entire end-to-end chain.'.

64. In the Name field, type 'PaymentModel'.

The PaymentModel name aligns with predefined interfaces of payment forms.

65. Click Save.

66. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Prepare application metadata to be used in RCS
2/18/2021 • 2 minutes to read • Edit Online

Prerequisites

Add metadata configuration

NOTENOTE

The following steps explain how a user in the System Administrator or Electronic Reporting Developer role can

create a new Electronic reporting (ER) configuration that contains application metadata for designing ER model

mapping configurations in Regulatory configuration service (RCS). This configuration will be used for designing

a sample ER model mapping configuration to access foreign trade transactions. In this example, you will create a

configuration for sample company, Litware, Inc. These steps can be performed in any company. To complete

these steps, you must first complete the steps in the topic, Create configuration providers and mark them as

active.

1. Go to Organization administrationOrganization administration > WorkspacesWorkspaces  > Electronic repor tingElectronic repor ting.

2. Make sure that the configuration provider for the sample company, Litware, Inc., is available and marked as

ActiveActive. If you don't see this configuration provider, complete the steps in the procedure Create configuration

providers and mark them as active.

3. Click Metadata configurationsMetadata configurations .

4. Assume that RCS will be used to design an ER solution for a Finance and Operation application that will

generate electronic documents that contain information from foreign trade business domain. To specify the

mapping between ER data model and sources of required data, in RCS we need to have access to metadata

of the Finance and Operation application. Therefore, as part of designing ER solution we configure a new ER

metadata configuration containing all metadata that is currently required for generation ER reports for

selected business domain.

1. Click Create configurationCreate configuration to open the drop dialog.

2. In the NameName field, type 'Foreign trade metadata'.

3. Click Create configurationCreate configuration.

4. Click DesignerDesigner .

5. Click AddAdd.

You can select all metadata for the entire application or selected models or selected modules. Be aware that in this case

the following metadata will be automatically added: tables of records, enumerations, and extended data types. When

additional types of metadata are needed, they must be added manually.

We have some foreign trade transactions related metadata by selecting metadata items manually.

6. Click Add data sourceAdd data source.

7. Click Table recordsTable records .

8. Use the Quick Filter to filter on the NameName field with a value of 'Intrastat'.

9. Select the IntrastatIntrastat table record.

10. Click OKOK.

We added metadata information about the Intrastat table of records.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/prepare-application-metadata-rcs.md
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Complete the draft version of metadata configuration

Export the completed version of metadata configuration from
application as XML file

NOTENOTE

11. In the tree, expand Table records IntrastatTable records Intrastat>RelationsRelations .

12. In the tree, select Table records IntrastatTable records Intrastat>Relations\IntrastatCommodity (Table recordsRelations\IntrastatCommodity (Table records

EcoResCategor y)EcoResCategor y) .

13. Click Add metadataAdd metadata.

Metadata about required relations for selected table of records must be added manually.

16. Click Add data sourceAdd data source.

17. Click EnumerationEnumeration.

18. Use the Quick Filter to filter on the NameName field with a value of 'IntrastatDirection'.

19. Select the IntrastatDirection enumerationIntrastatDirection enumeration record.

20. Click OKOK.

21. Click SaveSave.

22. Close the page.

1. Click Change statusChange status .

2. Click CompleteComplete.

3. Click OKOK.

4. Select the completed version 11 .

1. Click ExchangeExchange.

2. Click Expor t as XML fileExpor t as XML file.

3. Click OKOK.

The created ER metadata configuration has been saved as XML file that can be imported to RCS and used as the

source of information about metadata for the foreign trade business domain. Based on this information, we can

specify the mapping between application metadata and ER data model.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Access application metadata by using ER
configuration
2/18/2021 • 3 minutes to read • Edit Online

Prerequisites

Import metadata configuration

Create data model configuration

The following steps explain how a Regulatory configuration service (RCS) user in the System Administrator or

Electronic Reporting Developer role can design a new Electronic reporting (ER) model mapping by using the

application metadata. Application metadata will be accessed by using an ER metadata configuration that

contains a sample set of metadata to access foreign trade transactions. To complete these steps, in RCS you

must first complete the steps in the topic, Create configuration providers and mark them as active procedure.

Then complete the steps in the topic, Prepare application metadata to be used in RCS.

1. Go to All workspacesAll workspaces  > Electronic repor tingElectronic repor ting.

2. Make sure that the configuration provider for the sample company, Litware, Inc., is available and marked as

ActiveActive. If you don't see this configuration provider, complete the steps in the procedure Create configuration

providers and mark them as active.

1. Click Metadata configurationsMetadata configurations .

2. Import the ER metadata configuration that contains metadata that has been configured to generate

electronic documents for foreign trade business. This ER metadata configuration has been exported as XML

file while the steps in the Prepare application metadata to be used in RCS procedure have been completed.

3. Click ExchangeExchange.

4. Click Load from XML fileLoad from XML file.

5. Click BrowseBrowse and select the 'Foreign trade metadata.xml' file.

6. Click OKOK.

7. Close the page.

1. Click Repor ting configurationsRepor ting configurations .

2. Click Create configurationCreate configuration to open the drop dialog.

3. In the NameName field, type 'Foreign trade model'.

4. Click Create configurationCreate configuration.

5. Click DesignerDesigner .

6. Click NewNew  to open the drop dialog.

7. In the NameName field, type 'Root'.

8. Click AddAdd.

9. Click NewNew  to open the drop dialog.

10. In the NameName field, type 'Transaction'.

11. In the Item typeItem type field, select Record listRecord list.

12. Click AddAdd.

13. Click NewNew  to open the drop dialog.

14. In the NameName field, type 'Commodity code'.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/access-application-metadata-er-configuration.md


Create model mapping configuration
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15. In the Item typeItem type field, select Str ingStr ing.

16. Click AddAdd.

17. Click NewNew  to open the drop dialog.

18. In the NameName field, type 'Invoiced amount'.

19. In the Item typeItem type field, select RealReal .

20. Click AddAdd.

21. Click NewNew  to open the drop dialog.

22. In the NameName field, type 'Date'.

23. In the Item typeItem type field, select DateDate.

24. Click AddAdd.

25. Click Root referenceRoot reference.

26. Click OKOK.

27. Click SaveSave.

28. Close the page.

29. Click Change statusChange status .

30. Click CompleteComplete.

31. Click OKOK.

1. Click Create configurationCreate configuration to open the drop dialog.

2. In the NewNew  field, enter 'Model Mapping based on data model Foreign trade model'.

3. In the NameName field, type 'Foreign trade mapping'.

4. Click Create configurationCreate configuration.

5. Expand the PrerequisitesPrerequisites  section.

6. Click EditEdit.

7. Click NewNew .

8. In the list, mark the selected row.

9. In the Prerequisite component typePrerequisite component type field, select ConfigurationConfiguration.

10. Select Foreign trade metadataForeign trade metadata configuration.

11. Click SaveSave.

12. We added the reference to the version 1 of the 'Foreign trade metadata' configuration. Application metadata

from this configuration will be offered while this model mapping will be designed.

13. Close the page.

14. Click DesignerDesigner .

15. Click DesignerDesigner .

16. In the tree, select Dynamics 365 for Operations\Table recordsDynamics 365 for Operations\Table records .

17. Click Add rootAdd root.

18. In the NameName field, type 'Intrastat'.

19. Select IntrastatIntrastat table records.

20. Click OKOK.

The only 2 tables were offered as the only 2 tables were added into the set of metadata which is currently in use.

21. Click BindBind.

22. In the tree, expand IntrastatIntrastat.
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23. In the tree, select Intrastat\AmountMSTIntrastat\AmountMST.

24. In the tree, expand Transaction = IntrastatTransaction = Intrastat.

25. In the tree, select Transaction = Intrastat\Invoiced amountTransaction = Intrastat\Invoiced amount.

26. Click BindBind.

27. In the tree, select Intrastat\TransDateIntrastat\TransDate.

28. In the tree, select Transaction = Intrastat\DateTransaction = Intrastat\Date.

29. Click BindBind.

30. In the tree, expand Intrastat>RelationsIntrastat>Relations .

31. In the tree, expand Intrastat>Relations\IntrastatCommodityIntrastat>Relations\IntrastatCommodity .

32. In the tree, select Intrastat>Relations\IntrastatCommodity\CodeIntrastat>Relations\IntrastatCommodity\Code.

33. In the tree, select Transaction = Intrastat\Commodity codeTransaction = Intrastat\Commodity code.

34. Click BindBind.

35. Click ValidateValidate.

We have successfully bound elements of data model with items of data sources that are described by using details of

application metadata from the referred ER metadata configuration. 36. Click SaveSave. 37. Close the page. 38. Close the page.

39. When needed, you can extend the existing set of metadata and then export the new completed version of ER

metadata configuration. You can then import it to RCS, and update the prerequisites of the configured model mapping

configuration referring to a new version of imported metadata configuration.

This way of getting information about application metadata is the only one available for locally deployed applications

(when local business data (LBD), or on-premises, deployment model is used).

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Prerequisites

Get required ER configurations

Register a connected application

The following steps explain how a Regulatory configuration service (RCS) user in the System Administrator or

Electronic Reporting Developer role can design a new Electronic reporting (ER) model mapping by using

metadata in Finance and Operations. Application metadata will be accessed online by using the RCS connected

application. Sample ER model mapping will be configured to access foreign trade transactions. To complete

these steps, in RCS you must first complete the steps in the topic, Create configuration providers and mark them

as active. If you have not completed the steps in the topic, Access application metadata by using ER

configuration, go to the Electronic reporting examples page to download and save the following ER

configurations: Foreign trade metadata.xml; Foreign trade model.xml; Foreign trade mapping.xml, and then

complete the steps in the procedure.

1. Go to All workspacesAll workspaces  > Electronic repor tingElectronic repor ting.

2. Make sure that the configuration provider for the sample company, Litware, Inc., is available and marked as

ActiveActive. If you don't see this configuration provider, complete the steps in the procedure Create configuration

providers and mark them as active.

1. Click Repor ting configurationsRepor ting configurations .

2. If you already completed the steps in the Access application metadata by using ER configuration procedure,

you already have all necessary ER configurations (foreign trade metadata, model and mapping

configurations) in the current RCS instance. You can skip all the remaining steps of this sub-task.

3. Click ExchangeExchange.

4. Click Load from XML fileLoad from XML file.

5. Click BrowseBrowse and select the Foreign trade metadata.xmlForeign trade metadata.xml  file.

6. Click OKOK.

7. Click ExchangeExchange.

8. Click Load from XML fileLoad from XML file.

9. Click BrowseBrowse and select the Foreign trade model.xmlForeign trade model.xml  file.

10. Click OKOK.

11. Click ExchangeExchange.

12. Click Load from XML fileLoad from XML file.

13. Click BrowseBrowse and select the Foreign trade mapping.xmlForeign trade mapping.xml  file.

14. Click OKOK.

1. Close the page.

2. Close the page.

3. Go to All workspacesAll workspaces  > Electronic repor tingElectronic repor ting.

4. Click Connected applicationsConnected applications .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/access-application-metadata-using-connected-applications.md
https://go.microsoft.com/fwlink/?linkid=862266


Review existing model mapping configuration

Assign connected application to model mapping

5. Make sure that the configured application is Azure based and accessible for the current RCS user. It is also

required that the current RCS user has access to the selected application and has been registered as a user of

this application playing a role giving them privileges to access application's metadata.

6. Click NewNew .

7. In the NameName field, type 'MyConnectedApp'.

8. In the ApplicationApplication field, type 'https:// mycompany.operations.dynamics.com'.

9. In the TenantTenant field, type 'mycompany.onmicrosoft.com'.

10. Click SaveSave.

11. When you check connection to configured application, on the Connect to remote applicationConnect to remote application page click

Click here to connect to selected remote applicationClick here to connect to selected remote application link.

12. Click Check connectionCheck connection.

13. Click CloseClose.

14. When the connection validation succeeded, version and tenant details will be updated for the configured

application in the current grid.

NOTENOTE
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1. Close the page.

2. Click Repor ting configurationsRepor ting configurations .

3. In the tree, expand Foreign trade modelForeign trade model .

4. In the tree, select Foreign trade model\Foreign trade mappingForeign trade model\Foreign trade mapping.

5. Expand the PrerequisitesPrerequisites  section.

Currently, this mapping refers to the metadata configuration. Application metadata from this configuration will be

offered while this model mapping will be designed.

6. Click DesignerDesigner .

7. Click DesignerDesigner .

8. In the tree, select Dynamics 365 for Operations\Table recordsDynamics 365 for Operations\Table records .

9. Click Add rootAdd root.

10. In the TableTable field, enter or select a value.

Currently, this mapping refers to the metadata configuration. Application metadata from this configuration will be

offered while this model mapping will be designed.

11. Click CancelCancel .

12. Close the page.

13. Close the page.



NOTENOTE

NOTENOTE

NOTENOTE

NOTENOTE

1. Click EditEdit.

2. Select MyConnectedAppMyConnectedApp application.

Currently, this mapping refers to the metadata of the selected connected application. When the same mapping

refers to metadata configuration and connected application at the same time, metadata of the connected

application will be used.

3. Click DesignerDesigner .

4. Click DesignerDesigner .

5. In the tree, select Dynamics 365 for Operations\Table recordsDynamics 365 for Operations\Table records .

6. Click Add rootAdd root.

7. In the TableTable field, enter or select a value.

More than two application tables were offered now as this mapping uses all the metadata of the connected

application that has been assigned for it.

8. Click CancelCancel .

9. Click ValidateValidate.

We successfully bound elements of data model with items of data sources that are described by using details of

metadata of the connected application that has been assigned for this mapping.

10. Close the page.

11. Close the page.

When you need to evaluate this model mapping by using metadata of a different version application, register

another connected application, assign it to this model mapping and validate it against new metadata.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Define ER model mappings and select data sources
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2/18/2021 • 4 minutes to read • Edit Online

Open the Electronic Reporting configurations tree

Insert a new model mapping

Define required data sources for the current model mapping

The following steps explain how a user in the System Administrator or Electronic Reporting Developer role can

select data sources for an Electronic reporting (ER) data model. The data sources will be bound to individual

components of the selected data model at design time and populate business data to that data model at run-

time. In this example, you will select data sources for an existing data model that has been created for sample

company, Litware, Inc. To complete these steps, you must first complete the steps in the "Create a new data

model" procedure.

1. Go to Organization administration > Workspaces > Electronic reporting.

2. Click Reporting configurations.

1. In the tree, select 'Payments (simplified model)'.

2. Click Designer.

3. Click Map model to datasource.

4. Click New.

5. In the Name field, type 'CT mapping'.

6. In the Description field, type 'Payment model mapping CT'.

7. In the Definition field, type 'CustomerCreditTransferInitiation'.

8. ResolveChanges the Definition.

9. Click Save.

This will create a new record that will map the data model to data sources. In this example, you will

map the data model to data sources for the desired payment type: credit transfer. It is possible to

design more than one mapping for a particular data model. For example, you could create a mapping

for the different types of payments, such as for direct debit or for credit transfers. In this example, you

will create a mapping for credit transfers.

CT mapping

Payment model mapping CT

CustomerCreditTransferInitiation

1. Click Designer.

2. In the tree, select 'Dynamics 365 for Operations\Table records'.

3. Click Add root.

4. In the Name field, type 'Transactions'.

5. In the Label field, enter 'Transactions'.

Enter this data source to access payment transactions.

Transactions

Transactions

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-define-model-mapping-select-data-sources-2016-11.md


6. In the Help field, enter 'Ledger journal lines'.

7. Select Yes in the Ask for query field.

8. In the Table field, type 'LedgerJournalTrans'.

9. Click OK.

10. In the tree, select 'Functions\Calculated field'.

11. Click Add.

12. In the Name field, type '$EndToEndID'.

13. Click Edit formula.

14. In the tree, select 'String\CONCATENATE'.

15. Click Add function.

16. In the tree, expand 'Transactions'.

17. In the tree, select 'Transactions\Voucher'.

18. Click Add data source.

19. In the Formula field, enter 'CONCATENATE(Transactions.Voucher, "-", '.

20. In the tree, select 'String\TEXT'.

21. Click Add function.

22. In the tree, select 'Transactions\Record-ID(RecId)'.

23. Click Add data source.

24. In the Formula field, enter 'CONCATENATE(Transactions.Voucher, "-", TEXT(Transactions.RecId))'.

25. Click Save.

26. Close the page.

27. Click OK.

28. Click Add.

29. In the Name field, type '$Amount'.

30. Click Edit formula.

31. In the tree, expand 'Transactions'.

32. In the tree, select 'Transactions\Debit(AmountCurDebit)'.

33. Click Add data source.

34. In the Formula field, enter 'Transactions.AmountCurDebit - '.

35. In the tree, select 'Transactions\Credit(AmountCurCredit)'.

36. Click Add data source.

37. Click Save.

38. Close the page.

Ledger journal lines

Select Yes.

LedgerJournalTrans

Select the LedgerJournalTrans table as a data source for the current data model.

Click Add to add a new calculated field.

$EndToEndID

Type [ , "-", ] at the end of the formula.

Type [))] at the end of the formula.

Make sure that no errors have been discovered for the created formula. See the ERRORS tab below

the formula editor control.

Add the calculated field to this data source.

Click Add to add a new calculated field.

$Amount

Type [ - ] at the end of the formula.



39. Click OK.

40. In the tree, select 'Transactions$Amount'.

41. In the tree, expand 'Transactions'.

42. In the tree, expand or collapse 'Transactions$Amount'.

43. In the tree, expand or collapse 'Transactions'.

44. In the tree, select 'Dynamics 365 for Operations\Table records'.

45. Click Add root.

46. In the Name field, type 'BankAccount'.

47. In the Label field, enter 'Bank Account'.

48. In the Help field, enter 'Bank Account'.

49. Select Yes in the Ask for query field.

50. In the Table field, type 'BankAccountTable'.

51. Click OK.

52. Click Add root.

53. In the Name field, type 'Company'.

54. In the Label field, type a value.

55. In the Help field, enter 'Company information'.

56. Select Yes in the Ask for query field.

57. In the Table field, type 'CompanyInfo'.

58. Click OK.

59. In the tree, select 'Functions\Calculated field'.

60. Click Add root.

61. In the Name field, type 'ProcessingDateTime'.

62. In the Label field, enter 'Processing date & time'.

63. Click Edit formula.

64. In the tree, select 'Date/time\SESSIONNOW'.

65. Click Add function.

66. Click Save.

This will add the $Amount calculated field to the selected data source for the current data model.

Enter this data source to access the company's bank account details.

BankAccount

Bank Account

Bank Account

Select Yes.

BankAccountTable

Select the BankAccountTable table as a data source for the current data model.

Enter this data source to access the company's requisites.

Company

Company information

Company information

Select Yes.

CompanyInfo

Select the CompanyInfo table as a data source for the current data model.

Insert a calculated field as a new data source.

ProcessingDateTime

Processing date & time



NOTENOTE

67. Close the page.

68. Click OK.

69. Click Save.

70. Close the page.

71. Close the page.

72. Close the page.

Add the ProcessingDateTime calculated field as a data source for the current data model.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Open ER configurations tree

Select created model mapping

Bind created data sources to data model elements

The following steps explain how a user in the System Administrator or Electronic Reporting Developer role can

map an Electronic reporting (ER) data model to selected data sources. This model mapping will later be used as

a data source in a format configuration that will be used to manage electronic payment documents. In this

example, you map a data model for sample company, Litware, Inc. to data sources. To complete these steps, you

must first complete the steps in the "Select data sources for model mapping" procedure.

1. Go to Organization administration > Workspaces > Electronic reporting.

2. Click Configurations.

1. In the tree, select 'Payments (simplified model)'.

2. Click Model designer.

3. Click Map model to datasource.

4. Select the 'CT mapping' record.

Make sure that the model configuration "Payments (simplified model)" has been created in advance.

Otherwise, stop now and return after completion of the task guide 'Create a new configuration with

data model of the selected domain'.

CT mapping

1. Click Designer.

2. In the tree, select 'Processing date & time(ProcessingDateTime)'.

3. In the tree, select 'Processing date(ProcessingDateTime)'.

4. Click Bind.

5. In the tree, select 'Payment message identification(MessageIdentification)'.

6. In the tree, expand 'Transactions'.

7. In the tree, select 'Transactions\Journal batch number(JournalNum)'.

8. Click Bind.

9. In the tree, select 'Payments'.

10. In the tree, select 'Transactions'.

11. Click Bind.

12. In the tree, expand 'Payments= Transactions'.

13. In the tree, expand 'Payments= Transactions\Creditor'.

14. In the tree, expand 'Payments= Transactions\Creditor\Account'.

15. In the tree, select 'Payments= Transactions\Creditor\Account\Currency code(Currency)'.

16. In the tree, expand 'Transactions\vendBankAccountInTransactionCompany()'.

17. In the tree, select 'Transactions\vendBankAccountInTransactionCompany()\Currency(CurrencyCode)'.

18. Click Bind.

19. In the tree, select 'Payments= Transactions\Creditor\Account\IBAN code(IBAN)'.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-map-data-model-selected-data-sources-2016-11.md


20. In the tree, select 'Transactions\vendBankAccountInTransactionCompany()\IBAN(BankIBAN)'.

21. Click Bind.

22. In the tree, select 'Payments= Transactions\Creditor\Account\Number'.

23. In the tree, select 'Transactions\vendBankAccountInTransactionCompany()\Bank account

number(AccountNum)'.

24. Click Bind.

25. In the tree, expand 'Payments= Transactions\Creditor\Agent'.

26. In the tree, select 'Payments= Transactions\Creditor\Agent\Name'.

27. In the tree, select 'Transactions\vendBankAccountInTransactionCompany()\Name'.

28. Click Bind.

29. In the tree, select 'Payments= Transactions\Creditor\Agent\Routing number(RoutingNumber)'.

30. In the tree, select 'Transactions\vendBankAccountInTransactionCompany()\Routing

number(RegistrationNum)'.

31. Click Bind.

32. In the tree, select 'Payments= Transactions\Creditor\Agent\SWIFT code(SWIFT)'.

33. In the tree, select 'Transactions\vendBankAccountInTransactionCompany()\SWIFT code(SWIFTNo)'.

34. Click Bind.

35. In the tree, select 'Payments= Transactions\Creditor\Name'.

36. In the tree, expand 'Transactions\findVendTable()'.

37. In the tree, select 'Transactions\findVendTable()\name()'.

38. Click Bind.

39. In the tree, select 'Payments= Transactions\Currency code(Currency)'.

40. In the tree, expand 'Transactions>Relations'.

41. In the tree, expand 'Transactions>Relations\Currency table(Currency)'.

42. In the tree, select 'Transactions>Relations\Currency table(Currency)\Currency code(CurrencyCodeISO)'.

43. Click Bind.

44. In the tree, expand 'Payments= Transactions\Debtor'.

45. In the tree, expand 'Payments= Transactions\Debtor\Account'.

46. In the tree, select 'Payments= Transactions\Debtor\Account\Currency code(Currency)'.

47. In the tree, select 'Bank Account(BankAccount)'.

48. In the tree, expand 'Bank Account(BankAccount)'.

49. In the tree, select 'Bank Account(BankAccount)\Currency(CurrencyCode)'.

50. Click Bind.

51. In the tree, select 'Bank Account(BankAccount)\IBAN'.

52. In the tree, select 'Payments= Transactions\Debtor\Account\IBAN code(IBAN)'.

53. Click Bind.

54. In the tree, select 'Payments= Transactions\Debtor\Account\Number'.

55. In the tree, select 'Bank Account(BankAccount)\Bank account number(AccountNum)'.

56. Click Bind.

57. In the tree, expand 'Payments= Transactions\Debtor\Agent'.

58. In the tree, select 'Payments= Transactions\Debtor\Agent\Name'.

59. In the tree, select 'Bank Account(BankAccount)\Name'.

60. Click Bind.

61. In the tree, select 'Payments= Transactions\Debtor\Agent\Routing number(RoutingNumber)'.

62. In the tree, select 'Bank Account(BankAccount)\Routing number(RegistrationNum)'.

63. Click Bind.

64. In the tree, select 'Payments= Transactions\Debtor\Agent\SWIFT code(SWIFT)'.



Validate created mapping

Change the status of the current version of model configuration

NOTENOTE

65. In the tree, select 'Bank Account(BankAccount)\SWIFT code(SWIFTNo)'.

66. Click Bind.

67. In the tree, select 'Payments= Transactions\Debtor\Name'.

68. In the tree, select 'Company information(Company)'.

69. In the tree, expand 'Company information(Company)'.

70. In the tree, select 'Company information(Company)\Name'.

71. Click Bind.

72. In the tree, select 'Payments= Transactions\Description'.

73. In the tree, select 'Transactions\Description(Txt)'.

74. Click Bind.

75. In the tree, select 'Payments= Transactions\End to end identification code(End2EndID)'.

76. In the tree, select 'Transactions$EndToEndID'.

77. Click Bind.

78. In the tree, select 'Payments= Transactions\Instructed amount(InstructedAmount)'.

79. In the tree, select 'Transactions$Amount'.

80. Click Bind.

81. In the tree, select 'Payments= Transactions\Transaction date(TransactionDate)'.

82. In the tree, select 'Transactions\Date(TransDate)'.

83. Click Bind.

1. Click Validate.

2. Click the arrow to expand or collapse the Error List section.

3. Click Save.

4. Close the page.

5. Close the page.

6. Close the page.

Validate the new mapping to ensure that all bindings are okay.

1. Click Change status.

2. Click Complete.

3. In the Description field, type a value.

4. Click OK.

5. Select the completed version of the current configuration.

Change the status of designed model configuration – from Draft to Completed to make it available for

payment format design.

Select Complete.

For example, 'version 1'.

Note that the created configuration is saved as completed version 1.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Create a new format configuration

NOTENOTE

Design the format of an electronic document

This topic explains how a user in the System Administrator or Electronic Reporting Developer role can create a

format configuration for Electronic reporting (ER). This format configuration will define the format of electronic

documents that are used for processing payments. In this example, you will create a format configuration for

sample company, Litware, Inc. To complete these steps, you must first complete the steps in the "Map model to

selected datasources" procedure.

1. Go to Organization administration > Workspaces > Electronic repor tingOrganization administration > Workspaces > Electronic repor ting.

2. Click Repor ting configurationsRepor ting configurations .

3. In the tree, select Payments (simplified model)Payments (simplified model) .

4. Click Create configurationCreate configuration to open the drop dialog.

If you don't see Create configurationCreate configuration, you must enable design mode on the Electronic repor ting parametersElectronic repor ting parameters  page.

5. In the NewNew  field, enter Format based on data model PaymentModelFormat based on data model PaymentModel .

6. In the NameName field, type BACS (UK fictitious)BACS (UK fictitious) .

7. In the Descr iptionDescr iption field, type BACS vendor payment format (UK fictitious)BACS vendor payment format (UK fictitious) .

8. In the Data model definitionData model definition field, enter or select a value.

9. Click Create configurationCreate configuration. A new configuration has been created. The draft version can be used to store

the design format for managing electronic documents.

The active configuration provider is automatically entered here. This provider will be able to maintain

this configuration. Other providers can use this configuration, but will not be able to maintain it.

A particular format of electronic document can be defined. Leave this field blank if you want to select a

format at run-time.

1. Click DesignerDesigner .

2. Click Add rootAdd root to open the drop dialog.

3. In the tree, select Common\FileCommon\File.

4. In the NameName field, type XmlXml .

5. In the EncodingEncoding field, type UTF-8UTF-8 .

6. Click OKOK.

7. Click AddAdd.

8. In the tree, select XML\ElementXML\Element.

9. In the NameName field, type MessageMessage.

10. Click OKOK.

11. In the tree, select Xml\MessageXml\Message.

12. Click Add ElementAdd Element.

13. In the NameName field, type ProcessingDateProcessingDate.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-format-configuration-2016-11.md


14. Click OKOK.

15. Click Add ElementAdd Element.

16. In the Name field, type MessageIdMessageId.

17. Click OKOK.

18. Click Add ElementAdd Element.

19. In the NameName field, type PaymentsPayments .

20. Click OKOK.

21. In the tree, select Xml\Message\PaymentsXml\Message\Payments .

22. Click Add ElementAdd Element.

23. In the NameName field, type ItemItem.

24. Click OKOK.

25. In the tree, select Xml\Message\Payments\ItemXml\Message\Payments\Item.

26. Click AddAdd.

27. In the tree, select XML\Attr ibuteXML\Attr ibute.

28. In the Name field, type IdId.

29. Click OKOK.

30. Click AddAdd.

31. In the tree, select XML\ElementXML\Element.

32. In the Name field, type VendorVendor .

33. Click OKOK.

34. In the tree, select Xml\Message\Payments\Item\VendorXml\Message\Payments\Item\Vendor .

35. Click Add ElementAdd Element.

36. In the Name field, type NameName.

37. Click OKOK.

38. Click Add ElementAdd Element.

39. In the NameName field, type BankBank.

40. Click OKOK.

41. In the tree, select Xml\Message\Payments\Item\Vendor\BankXml\Message\Payments\Item\Vendor\Bank.

42. Click Add ElementAdd Element.

43. In the NameName field, type RoutingNumberRoutingNumber .

44. Click OKOK.

45. Click Add ElementAdd Element.

46. In the NameName field, type AccountNumberAccountNumber .

47. Click OKOK.

48. In the tree, select Xml\Message\Payments\Item\VendorXml\Message\Payments\Item\Vendor .

49. Click CopyCopy .

50. In the tree, select Xml\Message\Payments\ItemXml\Message\Payments\Item.

51. Click PastePaste.

52. In the NameName field, type PayerPayer .

53. In the tree, select Xml\Message\Payments\ItemXml\Message\Payments\Item.

54. Click Add ElementAdd Element.

55. In the NameName field, type CurrencyCurrency .

56. Click OKOK.

57. Click Add ElementAdd Element.

58. In the NameName field, type Descr iptionDescr iption.

59. Click OKOK.



Prepare format components for mapping to data model elements

60. Click Add ElementAdd Element.

61. In the Name field, type TransDateTransDate.

62. Click OKOK.

63. Click Add ElementAdd Element.

64. In the Name field, type AmountAmount.

65. Click OKOK.

1. In the tree, select Xml\Message\ProcessingDateXml\Message\ProcessingDate.

2. Click AddAdd to open the drop dialog.

3. In the tree, select Text\DateTimeText\DateTime.

4. In the FormatFormat field, type yyyy-MM-ddyyyy-MM-dd.

5. Click OKOK.

6. In the tree, select Xml\Message\Payments\Item\TransDateXml\Message\Payments\Item\TransDate.

7. Click Add DateTimeAdd DateTime.

8. In the FormatFormat field, type yyyy-MM-ddyyyy-MM-dd.

9. In the DateTimeDateTime type field, select DateDate.

10. Click OKOK.

11. In the tree, select Xml\Message\MessageIdXml\Message\MessageId.

12. Click AddAdd to open the drop dialog.

13. In the tree, select Text\Str ingText\Str ing.

14. Click OKOK.

15. In the tree, select Xml\Message\Payments\Item\Vendor\NameXml\Message\Payments\Item\Vendor\Name.

16. Click Add Str ingAdd Str ing.

17. Click OKOK.

18. In the tree, select Xml\Message\Payments\Item\Vendor\Bank\RoutingNumberXml\Message\Payments\Item\Vendor\Bank\RoutingNumber .

19. Click Add Str ingAdd Str ing.

20. Click OKOK.

21. In the tree, select Xml\Message\Payments\Item\Vendor\Bank\AccountNumberXml\Message\Payments\Item\Vendor\Bank\AccountNumber .

22. Click Add Str ingAdd Str ing.

23. Click OKOK.

24. In the tree, select Xml\Message\Payments\Item\Payer\NameXml\Message\Payments\Item\Payer\Name.

25. Click Add Str ingAdd Str ing.

26. Click OKOK.

27. In the tree, select Xml\Message\Payments\Item\Payer\Bank\RoutingNumberXml\Message\Payments\Item\Payer\Bank\RoutingNumber .

28. Click Add Str ingAdd Str ing.

29. Click OKOK.

30. In the tree, select Xml\Message\Payments\Item\Payer\Bank\AccountNumberXml\Message\Payments\Item\Payer\Bank\AccountNumber .

31. Click Add Str ingAdd Str ing.

32. Click OKOK.

33. In the tree, select Xml\Message\Payments\Item\CurrencyXml\Message\Payments\Item\Currency .

34. Click Add Str ingAdd Str ing.

35. Click OKOK.

36. In the tree, select Xml\Message\Payments\Item\Descr iptionXml\Message\Payments\Item\Descr iption.

37. Click Add Str ingAdd Str ing.

38. Click OKOK.
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39. In the tree, select Xml\Message\Payments\Item\AmountXml\Message\Payments\Item\Amount.

40. Click Add Str ingAdd Str ing.

41. Click OKOK.

42. Click SaveSave.

43. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Select a format configuration

Map format components to data model elements

The following procedure shows how a user in either the System administrator or Electronic reporting developer

role can map data model elements to components of the created Electronic reporting (ER) configuration, which

defines an electronic document format for the payments business domain. This format will be used later to

generate electronic documents for processing payments. In this example, you will create a format configuration

for the sample company, 'Litware, Inc.'. These steps can be performed in any company as ER configurations are

shared for all companies. To complete these steps, you must first complete the steps in the "Create a format

configuration" task guide.

1. Go to Organization administration > Workspaces > Electronic reporting.

2. Click Reporting configurations.

3. In the tree, expand 'Payments (simplified model)'.

4. In the tree, select 'Payments (simplified model)\BACS (UK fictitious)'.

5. Click Designer.

1. Click Expand/collapse.

2. Click the Mapping tab.

3. In the tree, expand 'model'.

4. In the tree, select 'Xml\Message\ProcessingDate\DateTime'.

5. In the tree, select 'model\ProcessingDateTime'.

6. Click Bind.

7. In the tree, select 'Xml\Message\MessageId\String'.

8. In the tree, select 'model\MessageIdentification'.

9. Click Bind.

10. In the tree, expand 'model\Payments'.

11. In the tree, select 'Xml\Message\Payments\Item\Amount\String'.

12. In the tree, select 'model\Payments\InstructedAmount'.

13. Click Bind.

14. In the tree, select 'Xml\Message\Payments\Item\TransDate\DateTime'.

15. In the tree, select 'model\Payments\TransactionDate'.

16. Click Bind.

17. In the tree, select 'Xml\Message\Payments\Item\Description\String'.

18. In the tree, select 'model\Payments\Description'.

19. Click Bind.

20. In the tree, select 'Xml\Message\Payments\Item\Currency\String'.

21. In the tree, select 'model\Payments\Currency'.

22. Click Bind.

23. In the tree, select 'Xml\Message\Payments\Item\Id'.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-map-components-data-model-elements--2016-11.md


Validate format mapping

Change status of the current version of format configuration

24. In the tree, select 'model\Payments\End2EndID'.

25. Click Bind.

26. In the tree, expand 'model\Payments\Creditor'.

27. In the tree, expand 'model\Payments\Creditor\Account'.

28. In the tree, expand 'model\Payments\Creditor\Agent'.

29. In the tree, select 'Xml\Message\Payments\Item\Vendor\Name\String'.

30. In the tree, select 'model\Payments\Creditor\Name'.

31. Click Bind.

32. In the tree, select 'Xml\Message\Payments\Item\Vendor\Bank\RoutingNumber\String'.

33. In the tree, select 'model\Payments\Creditor\Agent\RoutingNumber'.

34. Click Bind.

35. In the tree, select 'Xml\Message\Payments\Item\Vendor\Bank\AccountNumber\String'.

36. In the tree, select 'model\Payments\Creditor\Account\Number'.

37. Click Bind.

38. In the tree, select 'Xml\Message\Payments\Item\Payer\Name\String'.

39. In the tree, expand 'model\Payments\Debtor'.

40. In the tree, expand 'model\Payments\Debtor\Account'.

41. In the tree, expand 'model\Payments\Debtor\Agent'.

42. In the tree, select 'model\Payments\Debtor\Name'.

43. Click Bind.

44. In the tree, select 'Xml\Message\Payments\Item\Payer\Bank\RoutingNumber\String'.

45. In the tree, select 'model\Payments\Debtor\Agent\RoutingNumber'.

46. Click Bind.

47. In the tree, select 'Xml\Message\Payments\Item\Payer\Bank\AccountNumber\String'.

48. In the tree, select 'model\Payments\Debtor\Account\Number'.

49. Click Bind.

50. In the tree, select 'Xml\Message\Payments\Item'.

51. In the tree, select 'model\Payments'.

52. Click Bind.

53. Click Save.

1. Click Validate.

2. Close the page.

Validate the new mapping to ensure that all bindings are okay.

In the next steps, you'll change the status of the format configuration from Draft to Completed to make it

available for payment document generation.

1. Click Change status.

2. Click Complete.

3. In the Description field, type a value.

4. Click OK.

5. Select completed version of the current configuration.

For example, 'version 1'.



Define effective date for completed version of format

Restrict access to created format from companies

NOTENOTE

Note that the configuration is saved as completed version 1.1: version 1 of the format based on the

version 1 of the data model.

Each format version can be configured as available for usage starting from a certain date. When more than one

format version is active on a certain date, the latest format (based on version number) will be selected for usage.

The session date value is used for proper version selection.

1. Expand the ISO Country/region codes section.

Each format access can be restricted by identifying particular countries/regions in which a format is

applicable. When the list of countries/regions for particular format is empty, this format can be used in

any company. When some ISO country/region codes are inserted in the list of countries/regions, the

format can only be use in companies if the primary address is in the country/region.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


(ER) Import configurations from RCS
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Register a new ER repository.

Import ER configurations from RCS-based repository

The following steps explain how a user in the System Administrator or Electronic Reporting Developer role can

import a new version of an Electronic reporting (ER) configuration from Microsoft Regulatory Configuration

Services (RCS). In this example, you will select the version of the ER configuration that has been configured in an

RCS instance and import it into the current instance for sample company, Litware, Inc. These steps can be

performed in any company because ER configurations are shared among companies. To complete these steps,

you must first complete the steps in the topic, Create configuration providers and mark them as active. To

complete these steps, you must also have access to an RCS instance containing at least one ER configuration in

either CompletedCompleted or SharedShared status.

1. Go to Organization administrationOrganization administration > WorkspacesWorkspaces  > Electronic repor tingElectronic repor ting.

2. Make sure that the configuration provider for the sample company, Litware, Inc., is available and marked as

ActiveActive. If you don't see this configuration provider, complete the steps in the topic, Create configuration

providers and mark them as active.

3. If you have no RCS environment provisioned to your company, select Regulator y ser vices –Regulator y ser vices –

ConfigurationConfiguration external link and follow the instructions to provision an RCS environment.

4. Select Electronic repor ting parametersElectronic repor ting parameters .

5. Select the RCSRCS  tab.

6. If RCS environment has been already provisioned to your company, use presented on the page URLs to

access it.

7. Close the page.

1. In the list, mark the selected row.

2. Select Litware, Inc. provider.

3. Select Repositories.

4. Select Add to open the drop dialog.

5. In the Configuration repository type field, enter 'RCS'.

6. Select Create repository.

7. In the RCS environment display name field, enter or select a value.

8. Select the desired RCS instance. You can have several of them.

9. Select OK.

1. Select Show filtersShow filters .

2. Enter a filter value of "RCS" on the NameName field using the begins withbegins with filter operator.

3. When you open the selected repository, on the Connect to Regulator y Configuration Ser vicesConnect to Regulator y Configuration Ser vices  page,

select Select here to connect to Regulator y Configuration Ser vicesSelect here to connect to Regulator y Configuration Ser vices  link.

4. Select OpenOpen.

5. Select CloseClose.

6. Select the desired version of ER configuration and select Impor tImpor t to bring it in the current instance.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/import-configuration-rcs.md
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Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


ER Generate electronic documents for payments
using a format configuration
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Change the configuration of the electronic payment method

Test the format of generated payment files

The following steps explain how a user in the System Administrator or Electronic Reporting Developer role can

use a new Electronic reporting (ER) format configuration to generate electronic documents for processing

payments. These steps can be performed in the GBSI sample company.

To complete these steps, you must first complete the steps in the "Create a configuration with format of

payment document" procedure.

1. Go to Accounts payable > Payment setup > Methods of payment.

2. Toggle the File format section to expand it, if needed.

3. Use the Quick Filter to find records. For example, filter on the Method of payment field with a value of

'Electronic'.

4. Click Edit.

5. Set the General electronic reporting field to Yes.

6. In the Name field, click the drop-down button to open the lookup.

7. Select BACS (UK fictitious) format configuration.

8. Click Save.

9. Close the page.

Select Yes to use the General electronic reporting pattern for payment files generation.

1. Go to Accounts payable > Payments > Payment journal.

2. Click New.

3. In the list, mark the selected row.

4. In the Name field, click the drop-down button to open the lookup.

5. In the list, click the link in the selected row.

6. Click Save.

7. Click Lines.

8. In the Company field, type 'DEMF'.

9. In the Account field, specify the values 'DE-01001'.

10. In the Description field, type 'Payment'.

11. In the Debit field, enter a number.

12. Click the Payment tab.

13. In the Method of payment field, click the drop-down button to open the lookup.

Select VendPay.

DEMF

DE-01001

Payment

1000

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-electronic-payments.md
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14. In the list, find and select the desired record.

15. In the list, click the link in the selected row.

16. Click Save.

17. Click Generate payments.

18. In the Method of payment field, click the drop-down button to open the lookup.

19. In the list, find and select the desired record.

20. In the list, click the link in the selected row.

21. In the File name field, type a value.

22. In the Bank account field, click the drop-down button to open the lookup.

23. In the list, click the link in the selected row.

24. Click OK.

25. Click OK.

Select the Electronic value.

Select the Electronic value.

Select the Electronic value.

For example, type 'payments'.

Select the value GBSI OPER.

Analyze the created payment file in XML format. Compare it with the designed document layout and

defined payment transaction attributes.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


ER Upgrade your format by adopting a new, base
version of that format
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Select format configuration for customization

Create a new configuration for your custom format of electronic
document

The following steps explain how a user in the System Administrator or Electronic Reporting Developer role can

maintain an Electronic reporting (ER) format configuration. This procedure explains how a custom version of a

format can be created based on the format received from a configuration provider (CP). It also explains how to

adopt a new, base version of that format.

To complete these steps, you must first complete the steps in the "Create a configuration provider and mark it as

active" and "Use created format to generate electronic documents for payments" procedures. These steps can be

performed in the GBSI company.

1. Go to Organization administration > Workspaces > Electronic reporting.

In this example, sample company Litware, Inc. (https://www.litware.com) will act as a configuration

provider that supports format configurations for electronic payments for a particular country. Sample

company Proseware, Inc. (http://www.proseware.com) will act as a consumer of the format configuration

that Litware, Inc. provided. Proseware, Inc. uses formats in certain regions of that country.

2. Click Reporting configurations.

3. Click Show filters.

4. Apply the following filters: Enter a filter value of "BACS (UK fictitious)" on the "Name" field using the

"begins with" filter operator.

The selected format configuration BACS (UK fictitious) is owned by provider Litware, Inc.

5. Click Show filters.

6. In the list, find and select the desired record.

The version of the format with the status of Completed will be used by Proseware, Inc. for customization.

Proseware, Inc. received version 1.1 of BACS (UK fictitious) configuration that contains the initial format to

generate electronic payment documents from Litware, Inc. in accordance to their service subscription.

Proseware, Inc. wants to start using this as a standard for their country but some customization is required to

support specific regional requirements. Proseware, Inc. also wants to keep the ability to upgrade a custom

format as soon as a new version of it (with changes to support new country-specific requirements) comes from

Litware, Inc. and they want to perform this upgrade with the lowest cost.

To do this, Proseware, Inc. needs to create a configuration using the Litware, Inc. configuration BACS (UK

fictitious) as a base.

1. Close the page.

2. Select Proseware, Inc. to make it an active provider.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-upgrade-format.md
https://www.litware.com
http://www.proseware.com


Customize your format for the electronic document

3. Click Set active.

4. Click Reporting configurations.

5. In the tree, expand 'Payments (simplified model)'.

6. In the tree, select 'Payments (simplified model)\BACS (UK fictitious)'.

Select the BACS (UK fictitious) configuration from Litware, Inc. Proseware, Inc. will use version 1.1 as a

base for the custom version.

7. Click Create configuration to open the drop dialog.

This lets you create a new configuration for a custom payment format.

8. In the New field, enter 'Derive from Name: BACS (UK fictitious), Litware, Inc.'.

Select the Derive option to confirm the usage of BACS (UK fictitious) as the base for creating the custom

version.

9. In the Name field, type 'BACS (UK fictitious custom)'.

10. In the Description field, type 'BACS vendor payment (UK fictitious custom)'.

The active configuration provider (Proseware, Inc.) is automatically entered here. This provider will be

able to maintain this configuration. Other providers can use this configuration, but will not be able to

maintain it.

11. Click Create configuration.

1. Click Designer.

2. Click Expand/collapse.

3. Click Expand/collapse.

4. In the tree, select 'Xml\Message\Payments\Item\Vendor\Bank'.

5. Click Add to open the drop dialog.

6. In the tree, select 'XML\Element'.

7. In the Name field, type 'IBAN'.

8. Click OK.

9. In the tree, select 'Xml\Message\Payments\Item\Vendor\Bank\IBAN'.

10. Click Add to open the drop dialog.

11. In the tree, select 'Text\String'.

12. Click OK.

13. In the tree, select 'Xml\Message\Payments\Item\Vendor\Name\String'.

14. In the Maximum length field, enter '60'.

15. Click the Mapping tab.

16. In the tree, expand 'model'.

17. In the tree, expand 'model\Payments'.

18. In the tree, expand 'model\Payments\Creditor'.

19. In the tree, expand 'model\Payments\Creditor\Account'.

20. In the tree, select 'model\Payments\Creditor\Account\IBAN'.

21. In the tree, select 'Xml\Message\Payments\Item = model.Payments\Vendor\Bank\IBAN\String'.

22. Click Bind.

23. Click Save.



Validate the customized format

Change the status of the current version of the custom format
configuration

Test the customized format to generate payment files

Update the existing country-specific configuration

1. Click Validate.

Validate the customized format layout and data mapping changes to make sure that all bindings are okay.

2. Close the page.

Change the status of the designed format configuration from Draft to Completed to make it available for

payment document generation.

1. Click Change status.

Note that the current version of the selected configuration is in Draft status.

2. Click Complete.

3. In the Description field, type a value.

4. Click OK.

5. In the list, find and select the desired record.

Note that the created configuration is saved as completed version 1.1.1. This means it is version 1 of the

custom BACS (UK fictitious custom) format, which is based on version 1 of the BACS (UK fictitious)

format, which is based on version 1 of the Payments (simplified model) data model.

Complete the steps in the "Use created format to generate electronic documents for payments" procedure in a

parallel Finance and Operations session. Select the BACS (UK fictitious custom) format in electronic payment

method parameters. Make sure that the created payment file contains the recently introduced XML node

presenting IBAN code in accordance to regional requirements.

Litware, Inc. needs to update the BACS (UK fictitious) configuration and adopt new country requirements for

managing the format of the electronic document. Later, this will be enclosed in a new version of this

configuration that will be offered for service subscribers, including Proseware, Inc.

In real service provision related processes, each new version of BACS (UK fictitious) can be imported by

Proseware, Inc. from Litware, Inc. configurations' LCS repository. In this procedure we will simulate this by

updating BACS (UK fictitious) on behalf of a service provider.

1. Close the page.

2. Select Litware, inc. provider.

3. Click Set active.

4. Click Reporting configurations.

5. In the tree, expand 'Payments (simplified model)'.

6. In the tree, select 'Payments (simplified model)\BACS (UK fictitious)'.

The draft version owned by Litware, Inc. provider BACS (UK fictitious) is selected to bring in changes to



Localize the base format of the electronic document

Validate the localized format

Change the status of the current version of the base format
configuration

support new country-specific requirements.

Assume that there are new country-specific requirements to be supported by Litware, Inc.:

A value for the creditor's bank SWIFT code in each payment transaction.

A limit of 100 characters for the length of text for the vendor's name in a generating file.

New country-specific requirements

Select the draft version of the desired configuration to introduce required changes.

1. Click Designer.

2. Click Expand/collapse.

3. Click Expand/collapse.

4. In the tree, select 'Xml\Message\Payments\Item\Vendor\Bank'.

5. Click Add to open the drop dialog.

6. In the tree, select 'XML\Element'.

7. In the Name field, type 'SWIFT'.

8. Click OK.

9. In the tree, select 'Xml\Message\Payments\Item\Vendor\Bank\SWIFT'.

10. Click Add to open the drop dialog.

11. In the tree, select 'Text\String'.

12. Click OK.

13. In the tree, select 'Xml\Message\Payments\Item\Vendor\Name\String'.

14. In the Maximum length field, enter '100'.

15. Click the Mapping tab.

16. In the tree, expand 'model'.

17. In the tree, expand 'model\Payments'.

18. In the tree, expand 'model\Payments\Creditor'.

19. In the tree, expand 'model\Payments\Creditor\Agent'.

20. In the tree, select 'model\Payments\Creditor\Agent\SWIFT'.

21. In the tree, select 'Xml\Message\Payments\Item = model.Payments\Vendor\Bank\SWIFT\String'.

22. Click Bind.

23. Click Save.

1. Click Validate.

2. Close the page.

Change the status of the updated base format configuration from Draft to Completed to make it available for

generation of payment documents and updates of format configurations derived from it.

1. Click Change status.

Note that the current version of the selected configuration is in Draft status.

2. Click Complete.



Change the base version for the custom format configuration

Resolve rebase conflicts

3. In the Description field, type a value.

4. Click OK.

5. In the list, find and select the desired record.

Proseware, Inc. is informed that a new version 1.2 of BACS (UK fictitious) configuration is available to generate

electronic payment documents in accordance to recently announced country-specific requirements. Proseware,

Inc. wants to start using it as a standard for the country.

To do this, Proseware, Inc. needs to change the base configuration version for the custom configuration BACS

(UK fictitious custom). Instead of version 1.1 of BACS (UK fictitious) use new version 1.2.

1. Go to Organization administration > Workspaces > Electronic reporting.

2. Select the Proseware, Inc. provider to mark it as active.

3. Click Set active.

4. Click Reporting configurations.

5. In the tree, expand 'Payments (simplified model)'.

6. In the tree, expand 'Payments (simplified model)\BACS (UK fictitious)'.

7. In the tree, select 'Payments (simplified model)\BACS (UK fictitious)\BACS (UK fictitious custom)'.

Select the BACS (UK fictitious custom) configuration, which is owned by Proseware, Inc.

Use the draft version of the selected configuration to introduce required changes.

8. Click Rebase.

Select the new version 1.2 of the base configuration to be applied as a new base for updating the

configuration.

9. Click OK.

Note that some conflicts have been discovered between merging the custom version and a new base

version representing some format changes that can't be merged automatically.

1. Click Designer.

Note that changes to the vendor's name text length limit couldn't be resolved automatically. Therefore,

this is presented in a conflicts list. For each conflict of type Update, the following options are available: -

Apply a prior base value (button on top of the grid) to bring in the previous base version value (0 in our

case). - Apply a base value (button on top of the grid) to bring in the new base version value (100 in our

case). - Keep your own (custom) value (60 in our case). Click Apply base value to apply a country-specific

limit of 100 characters for vendor's name text length.

Note that Proseware, Inc. and Litware, Inc. have custom and local versions of this format using IBAN and

SWIFT codes with related components that are automatically merged in the managing format.

2. Click Apply base value.

Click Apply base value to apply the country-specific limit of 100 characters for vendor names.

3. Click Save.



Change the status of the new version of the custom format
configuration

Test the customized format for payment files generation

NOTENOTE

Saving the format will remove resolved conflicts from the conflicts list.

4. Close the page.

1. Click Change status.

Change the status of the updated, custom format configuration from Draft to Completed. This will make

the format configuration available for generating payment documents. Note that the current version of

the selected configuration is in Draft status.

2. Click Complete.

3. In the Description field, type a value.

4. Click OK.

Note that the created configuration is saved as completed version 1.2.2: version 2 of base BACS (UK

fictitious custom) format, which is based on version 2 of base BACS (UK fictitious) format, which is based

on version 1 of Payments (simplified model) data model.

Complete the steps in the "Use created format to generate electronic documents for payments" procedure in

parallel Finance and Operations session. Select the created 'BACS (UK fictitious custom)' format in electronic

payment method parameters. Make sure that the created payment file contains recently introduced by

Proseware, Inc. XML node presenting IBAN account code in accordance to regional requirements. The file also

should contain the recently introduced by Litware, Inc. XML node presenting SWIFT bank code in accordance to

country requirements.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Formula designer overview

Data binding

This topic explains how to use the formula designer in Electronic reporting (ER). When you design a format for a

specific electronic document in ER, you can use formulas to transform data so that it meets the requirements for

the document's fulfillment and formatting. These formulas resemble formulas in Microsoft Excel. Various types

of functions are supported in the formulas: text, date and time, mathematical, logical, information, and data type

conversion functions, and also other, business domain–specific functions.

ER supports the formula designer. Therefore, at design time, you can configure expressions that can be used for

the following tasks at runtime:

Transform data that is received from an application database and that should be entered in an ER data model

that is designed to be a data source for ER formats. (For example, these transformations might include

filtering, grouping, and data type conversion.)

Format data that must be sent to a generating electronic document in accordance with the layout and

conditions of a specific ER format. (For example, the formatting might be done in accordance with the

requested language or culture, or the encoding).

Control the process of creating electronic documents. (For example, the expressions can enable or disable the

output of specific elements of the format, depending on processing data. They can also interrupt the

document creation process or throw messages to users.)

You can open the Formula designerFormula designer  page when you perform any of the following actions:

Bind data source items to data model components.

Bind data source items to format components.

Complete maintenance of calculated fields that are part of data sources.

Define the visibility conditions for user input parameters.

Design a format's transformations.

Define the enabling conditions for the format's components.

Define the file names for the format's FILE components.

Define the conditions for process control validations.

Define the message text for process control validations.

The ER formula designer can be used to define an expression that transforms data that is received from data

sources, so that the data can be entered in the data consumer in the following ways at runtime:

From application data sources and runtime parameters to an ER data model

From an ER data model to an ER format

From application data sources and runtime parameters to an ER format

The following illustration shows the design of an expression of this type. In this example, the expression rounds

the value of the Intrastat.AmountMSTIntrastat.AmountMST field in the Intrastat table to two decimal places and then returns the

rounded value.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/general-electronic-reporting-formula-designer.md


Data formatting

The following illustration shows how an expression of this type can be used. In this example, the result of the

designed expression is entered in the Transaction.InvoicedAmountTransaction.InvoicedAmount component of the Tax repor ting modelTax repor ting model

data model.

At runtime, the designed formula, ROUND (Intrastat.AmountMST, 2) , rounds the value of the AmountMSTAmountMST field

for each record in the Intrastat table to two decimal places. It then enters the rounded value in the

Transaction.InvoicedAmountTransaction.InvoicedAmount component of the Tax repor tingTax repor ting data model.

The ER formula designer can be used to define an expression that formats data that is received from data

sources, so that the data can be sent as part of the generating electronic document. You might have formatting

that must be applied as a typical rule that should be reused for a format. In this case, you can introduce that

formatting one time in the format configuration, as a named transformation that has a formatting expression.

This named transformation can then be linked to many format components where the output must be

formatted according to the formatting expression that you created.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/picture-expression-binding.jpg
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The following illustration shows the design of a transformation of this type. In this example, the Tr immedStr ingTrimmedStr ing

transformation truncates incoming data of the String data type by removing leading and trailing spaces. It then

returns the truncated string value.

The following illustration shows how a transformation of this type can be used. In this example, several format

components send text as output to the generating electronic document at runtime. All these format components

refer to the Tr immedStr ingTrimmedStr ing transformation by name.

When format components, such as the par tyNamepar tyName component in the preceding illustration, refer to the

TrimmedStr ingTrimmedStr ing transformation, the transformation sends text as output to the generating electronic document.

This text doesn't include leading and trailing spaces.

If you have formatting that must be applied individually, you can introduce that formatting as an individual

expression of a binding of a specific format component. The following illustration shows an expression of this

type. In this example, the par tyTypepar tyType format component is bound to the data source via an expression that

converts incoming data from the Model.Company.RegistrationTypeModel.Company.RegistrationType field in the data source to uppercase

text. The expression then sends that text as output to the electronic document.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/picture-transformation-design.jpg
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Process flow control
The ER formula designer can be used to define expressions that control the process flow of generating electronic

documents. You can perform the following tasks:

Define conditions that determine when a document creation process must be stopped.

Specify expressions that either create messages for the user about stopped processes or throw execution log

messages about the continuing process of report generation.

Specify the file names of generating electronic documents, and control the conditions of their creation.

Each rule of the process flow control is designed as an individual validation. The following illustration shows a

validation of this type. Here is an explanation of the configuration in this example:

The validation is evaluated when the INSTATINSTAT node is created during generation of the XML file.

If the list of transactions is empty, the validation stops the execution process and returns FALSEFALSE.

The validation returns an error message that includes the text of label SYS70894 in the user's preferred

language.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/picture-binding-with-formula.jpg
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Document content control

The ER formula designer can also be used to generate a file name for a generating electronic document and to

control the file creation process. The following illustration shows the design of a process flow control of this

type. Here is an explanation of the configuration in this example:

The list of records from the model.Intrastatmodel.Intrastat data source is divided into batches. Each batch contains up to

1,000 records.

The output creates a zip file that contains one file in XML format for every batch that was created.

An expression returns a file name for generating electronic documents by concatenating the file name and

the file name extension. For the second batch and all subsequent batches, the file name contains the batch ID

as a suffix.

An expression enables (by returning TRUETRUE) the file creation process for batches that contain at least one

record.

The ER formula designer can be used to configure expressions that control what data will be put into generated

electronic documents at runtime. The expressions can enable or disable the output of specific elements of the

format, depending on processing data and configured logic. These expressions can be entered for a single

format element in the EnabledEnabled field on the MappingMapping tab of the Operations designerOperations designer  page. You can enter the

expressions as a logic condition that returns a Boolean value:

If the condition returns TrueTrue, the current format element is run.

If the condition returns FalseFalse, the current format element is skipped.

The following illustration shows expressions of this type. (Version 11.12.11 of the ISO20022 Credit transferISO20022 Credit transfer

(NO)(NO)  format configuration that is provided by Microsoft is used as an example.) The XMLHeaderXMLHeader  format

component is configured to describe the structure of the credit transfer message according to the ISO 20022

XML message standards. The

XMLHeader/Document/CstmrCdtTrfInitn/PmtInf/CdtTrfTxInf/RmtInf/UstrdXMLHeader/Document/CstmrCdtTrfInitn/PmtInf/CdtTrfTxInf/RmtInf/Ustrd format component is

configured to add the UstrdUstrd XML element to the generated message and to put the remittance information in

an unstructured format as text of the following XML elements:

The PaymentNotesPaymentNotes  component is used to generate the text of payment notes.

The DelimitedSequenceDelimitedSequence component generates comma-separated invoice numbers that are used to settle

the current credit transfer.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/picture-file-control.jpg


NOTENOTE

Validation of configured formulas

The PaymentNotesPaymentNotes and DelimitedSequenceDelimitedSequence components are labeled by using a question mark. A question mark

indicates that the use of a component is conditional. In this case, use of the components is based on the following criteria:

The @.PaymentsNotes <> ""  expression that is defined for the PaymentNotesPaymentNotes component enables (by

returning TRUETRUE) the UstrdUstrd XML element to be filled with the text of payment notes, if that text isn't blank for the

current credit transfer.

The @.PaymentsNotes = ""  expression that is defined for the DelimitedSequenceDelimitedSequence component enables (by

returning TRUETRUE) the UstrdUstrd XML element to be filled with a comma-separated list of the invoice numbers that are

used to settle the current credit transfer, if the text of payment notes for that credit transfer is blank.

Based on this setup, the message that is generated for each debtor payment, the UstrdUstrd XML element, will contain either

the text of payment notes or, when that text is blank, a comma-separated list of the invoice numbers that are used to

settle the payment.

On the Formula designerFormula designer  page, select TestTest to validate how the configured formula works.
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When the values of formula arguments are required, you can open the Test expressionTest expression dialog box from the

Formula designerFormula designer  page. In most cases, these arguments must be manually defined, because the configured

bindings aren't run at design time. The Test resultTest result tab on the Formula designerFormula designer  page shows the result from

execution of the configured formula.

The following example shows how you can test the formula that is configured for the foreign trade domain to

make sure that the Intrastat commodity code contains only digits.

When you test this formula, you can use the Test expressionTest expression dialog box to specify the value of the Intrastat

commodity code for testing.

After you specify the Intrastat commodity code and select OKOK, the Test resultTest result tab on the Formula designerFormula designer

page shows the result of execution of the configured formula. You can then evaluate whether the result is

acceptable. If the result isn't acceptable, you can update the formula and test it again.
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Additional resources

NOTENOTE

Some formulas can't be tested at design time. For example, a formula might return a result of a data type that

can't be shown on the Test resultTest result tab. In this case, you receive an error message that states that the formula

can't be tested.

Electronic Reporting overview

Electronic reporting formula language

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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 Act ivate the advanced formula editor

 Code autoformatt ing

Electronic reporting advanced formula editor
2/18/2021 • 4 minutes to read • Edit Online

NOTENOTE

In addition to the Electronic reporting formula editor, you can use the advanced Electronic reporting formula

editor to improve the experience of configuring Electronic reporting (ER) expressions. The advanced editor is

browser-based and powered by the Monaco editor. The most commonly used advanced editor features are

described in this topic:

Code autoformatting

IntelliSense

Code completion

Code navigation

Code structuring

Find and replace

Data pasting

Syntax colorization

Complete the following steps to start using the advanced formula editor in your instance of Microsoft Dynamics

365 Finance.

1. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > ConfigurationsConfigurations .

2. On the ConfigurationsConfigurations  page, on the Action Pane, on the ConfigurationsConfigurations  tab, in the AdvancedAdvanced

settingssettings  group, select User parametersUser parameters .

3. In the User parametersUser parameters  dialog box, in the Execution tracingExecution tracing section, set the Enable advanced formulaEnable advanced formula

editoreditor  parameter to YesYes .

Be aware that this parameter is user specific and company specific.

When you write a complex expression that consists of multiple rows of code, the indentation of a new entered

line will be automatic based on the indentation of the previous row. You can select lines and change their

indentation by typing TabTab or Shift+TabShift+Tab.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-advanced-formula-editor.md
https://microsoft.github.io/monaco-editor
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  I ntelliSense

 Code complet ion

Autoformatting allows you to keep the entire expression well formatted to make further maintenance easier and

to simplify understanding of the configured logic.

The editor provides word completion to help you write expression faster and avoid typos. When you start

adding new text, the editor automatically offers a list of functions supported in ER functions that contain the

characters you have entered. You can also trigger IntelliSense in any place of a configured expression by typing

Ctr l+SpaceCtr l+Space.

The editor automatically provides code completion by:

Inserting a closing bracket when an opening bracket is entered, keeping the cursor inside the brackets.

Inserting the second quotation symbol when the first one is entered, keeping the cursor inside the

quotations.

Inserting the second double quotation symbol when the first one is entered, keeping the cursor inside the

quotations.
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 Code navigat ion

 Code structur ing

When you point to the typed bracket, the second bracket of this pair is automatically highlighted to show the

construct that they support.

You can locate required symbols or lines in your expression by typing the Go toGo to command using the command

palette or the context menu.

For example, to jump to line 88 , do the following:

Press Ctr l+GCtr l+G, enter the value 88 , and then press EnterEnter .

-or-

Press F1F1 , type GG, select Go to lineGo to line, enter the value 88 , and the press EnterEnter .

The code for some functions, such as IF or CASE, is automatically structured. You can expand and collapse any or

all of the folding regions of this code to reduce the editable part of an expression in order to focus on only

thepiece of code that requires your attention. The toggle fold/unfold commands can be used for that.

For example, to fold all regions, do the following:

Press Ctr l+KCtr l+K

-or-

Press F1F1 , press FOFO, select Fold allFold all , and then press EnterEnter

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er-adveditor-codecompletion.gif
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 Find and replace

To unfold all regions, do the following:

Press Ctr l+JCtr l+J

-or-

Press F1F1 , type UNUN, select Unfold allUnfold all , and then press EnterEnter

To find occurrences of certain text, select the text in your expression, and do the following:

Press Ctr l+FCtr l+F  and then press F3F3  to find the next occurrence of the selected text, or press Shift+F3Shift+F3  to find

the previous occurrence.

-or-

Press F1F1 , type FF , and then select the required option to find the selected text.

To replace occurrences of a certain text, select the text in your expression, and do the following:

Press Ctr l+HCtr l+H. Enter the alternative text and select the replacement option to replace either the selected

text or all occurrences of this text in the current expression.

-or-

Press F1F1 , type RR , and then select the required option to replace the selected text. Enter the alternative text

and select the replacement option to replace either the selected text or all occurrences of this text in the

current expression.

To change all occurrences of a certain text, select the text in your expression, and do the following:

Press Ctr l+F2Ctr l+F2  and then enter the alternative text.

-or-

Press F1F1 , type CC, and then select the required option to change the selected text. Enter the alternative text.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er-adveditor-togglefold.gif


 Data sources and funct ions past ing

 Syntax color izat ion

You can select Add data sourceAdd data source, which pastes to the current expression a data source that is currently selected

on the Data sourceData source left panel. Simlilarly, you can select Add functionAdd function, which pastes to the current expression a

function that is currently selected on the FunctionsFunctions  right panel. If you use the ER formula editor, a selected

function or a selected data source will always be pasted to the end of the configured expression. When you use

the advanced ER formula editor, a selected function or a selected data source can be pasted to any part of the

configured expression. You will need to use the cursor to specify where you want to paste the data.

Currently, different colors are used to highlight the following parts of expressions:

The text in double brackets that can represent a label ID of a text constant.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er-adveditor-find.gif
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Limitations

Additional resources

NOTENOTE

The editor is currently supported in the following web browsers:

Chrome

Edge

Firefox

Opera

Safari

Electronic reporting (ER) overview

Formula designer in Electronic reporting

Monaco editor

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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  Constants

  O perators

Electronic reporting formula language
2/18/2021 • 7 minutes to read • Edit Online

Basic syntax

O P ERATO RO P ERATO R M EA N IN GM EA N IN G EXA M P L EEXA M P L E

+ Addition 1+2

- Subtraction, negation 5-2 , -1

* Multiplication 7\*8

/ Division 9/3

O P ERATO RO P ERATO R M EA N IN GM EA N IN G EXA M P L EEXA M P L E

= Equal X=Y

> Greater than X>Y

< Less than X<Y

Electronic reporting (ER) provides a powerful data transformation experience. The language that is used to

express the required data manipulations in the ER formula designer resembles the formula language in

Microsoft Excel.

ER expressions can contain any or all of the following elements:

Constants

Operators

References

Paths

Functions

When you design expressions, you can use text and numeric constants (that is, values that aren't calculated). For

example, the expression VALUE ("100") + 20  uses the numeric constant 2020  and the string constant "100""100", and it

returns the numeric value 120120 .

The ER formula designer supports escape sequences. Therefore, you can specify an expression string that should

be handled differently. For example, the expression "Leo Tolstoy ""War and Peace"" Volume 1"  returns the text

string Leo Tolstoy "War and Peace" Volume 1Leo Tolstoy "War and Peace" Volume 1 .

The following table shows the arithmetic operators that you can use to do basic mathematical operations, such

as addition, subtraction, multiplication, and division.

The following table shows the comparison operators that are supported. You can use these operators to

compare two values.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-formula-language.md


>= Greater than or equal to X>=Y

<= Less than or equal to X<=Y

<> Not equal to X<>Y

O P ERATO RO P ERATO R M EA N IN GM EA N IN G EXA M P L EEXA M P L E

O P ERATO RO P ERATO R M EA N IN GM EA N IN G EXA M P L EEXA M P L E

& Concatenate "Nothing to print:" & " " & "no
records found"

Operator precedenceOperator precedence

P REC EDEN C EP REC EDEN C E O P ERATO RSO P ERATO RS SY N TA XSY N TA X

7 Grouping ( … )

6 Member access … . …

5 Function call … ( … )

4 Multiplicative … * …
… / …

3 Additive … + …
… - …

2 Comparison … < …
… <= …
… => …
… > …
… = …
… <> …

1 Separation … , …

Additionally, you can use an ampersand (&) as a text concatenation operator. In this way, you can join, or

concatenate, one or more text strings into a single piece of text.

The order in which the parts of a compound expression are evaluated is important. For example, the result of

the expression 1 + 4 / 2  varies, depending on whether the addition or division operation is done first. You can

use parentheses to explicitly define how an expression is evaluated. For example, to indicate that the addition

operation should be done first, you can change the preceding expression to (1 + 4) / 2 . If you don't explicitly

indicate the order of operations in an expression, the order is based on the default precedence that is assigned

to the supported operators. The following table shows the precedence that is assigned to each operator.

Operators that have a higher precedence (for example, 7) are evaluated before operators that have a lower

precedence (for example, 1).

If an expression includes multiple consecutive operators that have the same precedence, those operations are

evaluated from left to right. For example, the expression 1 + 6 / 2 \* 3 > 5  returns truetrue. We recommend that

you use parentheses to explicitly indicate the desired order of operations in expressions, so that the expressions

are easier to read and maintain.



  References

  Paths

Relative pathRelative path

All data sources of the current ER component that are available during the design of an expression can be used

as named references. The current ER component can be either a model mapping or a format. For example, the

current ER model mapping contains the Repor tingDateRepor tingDate data source, which returns a value of the DateTime

data type. To correctly format that value in the generating document, you can reference the data source in the

expression as DATETIMEFORMAT (ReportingDate, "dd-MM-yyyy") .

All characters in the name of a referencing data source that don't represent a letter of the alphabet must be

preceded by a single quotation mark ('). If the name of a referencing data source contains at least one symbol

that doesn't represent a letter of the alphabet, the name must be enclosed in single quotation marks. For

example, these non-alphabetic symbols can be punctuation marks or other written symbols. Here are some

examples:

The Today's date & timeToday's date & time data source must be referred to in an ER expression as 'Today''s date & time' .

The name()name()  method of the CustomersCustomers  data source must be referred to in an ER expression as 

Customers.'name()' .

If the methods of application data sources have parameters, the following syntax is used to call those methods:

If the isLanguageRTLisLanguageRTL  method of the SystemSystem data source has an EN-USEN-US  parameter of the String data type,

this method must be referred to in an ER expression as System.isLanguageRTL("EN-US") .

Quotation marks aren't required when a method name contains only alphanumeric symbols. However, they

are required for a method of a table if the name includes brackets.

When the SystemSystem data source is added to an ER mapping that refers to the GlobalGlobal  application class, the

expression System.isLanguageRTL("EN-US ")  returns the Boolean value FALSEFALSE. The modified expression 

System.isLanguageRTL("AR")  returns the Boolean value TRUETRUE.

You can limit the way that values are passed to the parameters of this type of method:

Only constants can be passed to methods of this type. The values of the constants are defined at design time.

Only primitive (basic) data types are supported for parameters of this type. The primitive data types include

Integer, Real, Boolean, and String.

When an expression references a structured data source, you can use the path definition to select a specific

primitive element of that data source. A dot character (.) is used to separate individual elements of a structured

data source. For example, the current ER model mapping contains the InvoiceTransactionsInvoiceTransactions  data source, and

this data source returns a list of records. The InvoiceTransactionsInvoiceTransactions  record structure contains the AmountDebitAmountDebit

and AmountCreditAmountCredit fields, and both these fields return numeric values. Therefore, you can design the following

expression to calculate the invoiced amount: 

InvoiceTransactions.AmountDebit - InvoiceTransactions.AmountCredit . The InvoiceTransactions.AmountDebit

construction in this expression is the path that is used to access the AmountDebitAmountDebit field of the

InvoiceTransactionsInvoiceTransactions  data source of the Record list type.

If the path of a structured data source starts with an "at" sign (@), it's a relative path. The "at" sign is shown

instead of the remaining part of the absolute path of the hierarchical tree structure that is used. The following

illustration shows an example. Here, the absolute path Ledger.'accountingCurrency()'  indicates that the

accounting currency value from the LedgerLedger  data source is entered in the AccountingCurrencyAccountingCurrency  field of the

data model.



The example in the following illustration shows how a relative path is used. The relative path @.AccountNum

indicates that the AccountNumAccountNum field of the IntrastatIntrastat data source (which appears one level above the

AccountNumAccountNum field in the data model's hierarchical tree) is used to enter the customer or vendor account

number in the data model's AccountNumAccountNum field.

The remaining part of the absolute path is also shown in the ER formula editor.



   Funct ions

Functions list extension

Compound expressions

IF(ISEMPTY(IntrastatTotals), 0.0, IntrastatTotals.aggregated.'$AmountMSTRounded') 

Multiple solutions

IF(COUNT (IntrastatTotals)=0, 0.0, IntrastatTotals.aggregated.'$AmountMSTRounded') 

Additional resources

For more information, see Use a relative path in data bindings of ER models and formats.

ER built-in functions can be used in ER expressions. All data sources of the expression context (that is, the current

ER model mapping or ER format) can be used as parameters of calling functions, in accordance with the list of

arguments for calling functions. Constants can also be used as parameters of calling functions. For example, the

current ER model mapping contains the InvoiceTransactionsInvoiceTransactions  data source, and this data source returns a list of

records. The InvoiceTransactionsInvoiceTransactions  record structure contains the AmountDebitAmountDebit and AmountCreditAmountCredit fields, and

both these fields return numeric values. Therefore, to calculate the invoiced amount, you can design the

following expression that uses the built-in ER rounding function: 

ROUND (InvoiceTransactions.AmountDebit - InvoiceTransactions.AmountCredit, 2) .

When you design ER model mappings and ER reports, you can use ER functions from the following categories:

Date and time functions

List functions

Logical functions

Mathematical functions

Record functions

Text functions

Data collection functions

Other (business domain–specific) functions

Type conversion functions

ER lets you extend the list of functions that are used in ER expressions. Some engineering effort is required. For

detailed information, see Extend the list of Electronic reporting (ER) functions.

You can create compound expressions that use functions from different categories, provided that the data types

match. When you use functions together, match the data type of the output from one function to the input data

type that is required by another function. For example, to avoid a possible "list-is-empty" error in a binding of a

field to an ER format element, combine functions from the List category with a function from the Logical

category, as the following example shows. Here, the formula uses the IF function to test whether the

IntrastatTotalsIntrastatTotals  list is empty before it returns the value of the required aggregation from that list. If the

IntrastatTotalsIntrastatTotals  list is empty, the formula returns 00  (zero).

Often, you can get the same data transformation result in multiple ways, by using functions from different

categories or different functions from the same category. For example, the previous expression can also be

configured by using the COUNT function from the List category.

Electronic Reporting overview
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Formula designer in Electronic reporting

Extend the list of Electronic reporting functions

Can you tell us about your documentation language preferences? Take a short survey.
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List of ER functions in the Date and time category
2/18/2021 • 2 minutes to read • Edit Online

List of supported functions

F UN C T IO NF UN C T IO N DESC RIP T IO NDESC RIP T IO N

AddDays This function returns a DateTime value that is the specified
number of days before or after a specified start date.

DateFormat This function returns a String value that presents a given
date value as text in the specified format and in an optionally
specified culture.

DateTimeFormat This function returns a String value that presents a given
date/time value as text in the specified format and in an
optionally specified culture.

DateTimeValue This function returns a DateTime value that is converted
from a given text value in the specified format and in an
optionally specified culture to a date/time value.

DateToDateTime This function returns a DateTime value that is converted
from a given date value to a date/time value in Coordinated
Universal Time (Greenwich Mean Time [GMT]).

DateValue This function returns a Date value that is converted from a
given text value in the specified format and in an optionally
specified culture to a date value.

DayOfYear This function returns an Integer value that represents the
number of days between January 1 and the specified date.

Days This function returns an Integer value that represents the
number of days between one specified date and a second
specified date.

Now This function returns a DateTime value that represents the
current application server date and time.

NullDate This function returns a Date value that represents the nullnull
date (January 1, 1900).

NullDateTime This function returns a DateTime value that represents the
nullnull date/time value (January 1, 1900) in Coordinated
Universal Time.

SessionNow This function returns a DateTime value that represents the
current application session date and time.

Electronic reporting (ER) date and time functions can be used to extract information from date and time values,

and to perform operations on them. This topic provides a summary of these functions.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-category-datetime.md


SessionToday This function returns a Date value that represents the
current application session date.

Today This function returns a Date value that represents the
current application server date.

F UN C T IO NF UN C T IO N DESC RIP T IO NDESC RIP T IO N

Additional resources

NOTENOTE
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ADDDAYS ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

ADDDAYS (datetime, days)

Arguments

Return values

Usage notes

Example 1

Example 2

Additional resources

NOTENOTE

The ADDDAYS  function calculates a DateTime value that is the specified number of days before or after a

specified start date.

datetime : DateTime

A date/time value that represents the start date.

days : Integer

The number of days before or after datetime .

DateTime

The resulting date/time value.

A positive value for days  yields a future date. A negative value yields a past date.

ADDDAYS (NOW(), 7)  returns the date and time seven days in the future.

ADDDAYS (NOW(), -3)  returns the date and time three days in the past.

Date and time functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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DATEFORMAT ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax 1

DATEFORMAT (date, format)

Syntax 2

DATEFORMAT (date, format, culture)

Arguments

NOTENOTE

Return values

Usage notes

The DATEFORMAT  function returns a String value that presents a given date value as text in the specified format

and in an optionally specified culture. For information about the supported formats, see standard and custom.

date : Date

A date value that represents the date to format.

format : String

The format of the output string.

The format string is case-sensitive when you use either a standard format or a custom format. For example, the standard

"d" format specifier returns the date by using the short date pattern, whereas the standard "D" format specifier returns

the date by using the long date pattern. Additionally, the custom "M" format specifier returns the month from 1 through

12, whereas the custom "m" format specifier returns the minute from 0 through 59.

culture : String

The culture to use for formatting.

String

The resulting string value.

If the culture isn't defined as an argument of the called function, the value of culture  is defined by the calling

context. For example, if the DATEFORMAT  function is called by using syntax 1 in an Electronic reporting (ER)

format for a FILEFILE element that is configured to use the German culture, the conversion will be done by using the

German culture. The default culture  value is EN-USEN-US .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-datetime-dateformat.md
https://docs.microsoft.com/en-us/bingmaps/rest-services/common-parameters-and-types/supported-culture-codes
https://msdn.microsoft.com/library/az4se3k1(v=vs.110).aspx
https://msdn.microsoft.com/library/8kb3ddd4(v=vs.110).aspx
https://msdn.microsoft.com/library/az4se3k1(v=vs.110).aspx
https://msdn.microsoft.com/library/8kb3ddd4(v=vs.110).aspx


Example 1

Example 2

Additional resources

NOTENOTE

DATEFORMAT (TODAY (), "dd-MM-yyyy")  returns the current application server date, December 24, 2015, as the

string "24-12-2015""24-12-2015", based on the specified custom format.

DATEFORMAT (SESSIONTODAY (), "d", "DE")  returns the current application session date, December 24, 2015, as

the string "24-12-2015""24-12-2015", based on the selected German culture and the specified format.

Date and time functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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DATETIMEFORMAT ER function
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Syntax 1

DATETIMEFORMAT (datetime, format)

Syntax 2

DATETIMEFORMAT (datetime, format, culture)

Arguments

NOTENOTE

Return values

Usage notes

The DATETIMEFORMAT  function returns a String value that presents a given date/time value as text in the specified

format and in an optionally specified culture. For information about the supported formats, see standard and

custom.

datetime : DateTime

A date/time value that represents the date and time to format.

format : String

The format of the output string.

The format string is case-sensitive when you use either a standard format or a custom format. For example, the standard

"d" format specifier returns the date by using the short date pattern, whereas the standard "D" format specifier returns

the date by using the long date pattern. Additionally, the custom "M" format specifier returns the month from 1 through

12, whereas the custom "m" format specifier returns the minute from 0 through 59.

culture : String

The culture to use for formatting.

String

The resulting string value.

If the culture isn't defined as an argument of the called function, the value of culture  is defined by the calling

context. For example, if the DATETIMEFORMAT  function is called by using syntax 1 in an Electronic reporting (ER)

format for a FILEFILE element that is configured to use the German culture, the conversion will be done by using the

German culture. The default culture  value is EN-USEN-US .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-datetime-datetimeformat.md
https://docs.microsoft.com/en-us/bingmaps/rest-services/common-parameters-and-types/supported-culture-codes
https://msdn.microsoft.com/library/az4se3k1(v=vs.110).aspx
https://msdn.microsoft.com/library/8kb3ddd4(v=vs.110).aspx
https://msdn.microsoft.com/library/az4se3k1(v=vs.110).aspx
https://msdn.microsoft.com/library/8kb3ddd4(v=vs.110).aspx


Example 1

Example 2

Example 3

Additional resources

NOTENOTE

When the DATETIMEFORMAT  function converts a given date/time value, it considers the time zone setting of the

application user who is running the ER format that the function is called in the context of.

DATETIMEFORMAT (NOW(), "dd-MM-yyyy")  returns the current application server date/time value, December 24,

2015, as "24-12-2015""24-12-2015", based on the specified custom format.

DATETIMEFORMAT (SESSIONNOW(), "d", "DE")  returns the current application session date/time value, December

24, 2015, as "24.12.2015""24.12.2015", based on the selected German culture and the specified format.

DATETIMEFORMAT (DATETIMEVALUE( "2019-11-12T09:00:00.0000000-07:00", "O"), "O")  returns the string value 2019-2019-

11-12T08:00:00.0000000-08:0011-12T08:00:00.0000000-08:00  when the function is called during a process that was initiated by an

application user who has the time zone value (GMT-08:00) Pacific Time (US & Canada)(GMT-08:00) Pacific Time (US & Canada)  in the LanguageLanguage

and countr y/region preferencesand countr y/region preferences  section.

Date and time functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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DATETIMEVALUE ER function
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Syntax 1

DATETIMEVALUE (text, format)

Syntax 2

DATETIMEVALUE (text, format, culture)

Arguments

Return values

Usage notes

Example 1

Example 2

The DATETIMEVALUE  function returns a DateTime value that is converted from a given text value in the specified

format and in an optionally specified culture to a date/time value. For information about the supported formats,

see standard and custom.

text : String

Text that represents the value to format.

format : String

The format of the given text.

culture : String

The culture that is used for formatting of the given text.

DateTime

The resulting date/time value.

When the culture isn't defined as an argument of the called function, the value of culture  is defined by the

calling context. For example, if the DATETIMEVALUE  function is called by using syntax 1 in an Electronic reporting

(ER) format for a FILEFILE element that is configured to use the German culture, the conversion will be done by

using the German culture. The default culture  value is EN-USEN-US .

DATETIMEVALUE ("21-Dec-2016 02:55:00", "dd-MMM-yyyy hh:mm:ss")  returns 2:55:00 AM on December 21,2:55:00 AM on December 21,

20162016 , based on the specified custom format and the default application's EN-USEN-US  culture.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-datetime-datetimevalue.md
https://docs.microsoft.com/en-us/bingmaps/rest-services/common-parameters-and-types/supported-culture-codes
https://msdn.microsoft.com/library/az4se3k1(v=vs.110).aspx
https://msdn.microsoft.com/library/8kb3ddd4(v=vs.110).aspx


Additional resources

NOTENOTE

DATETIMEVALUE ("21-Gen-2016 02:55:00", "dd-MMM-yyyy hh:mm:ss", "IT")  returns 2:55:00 AM on December 21,2:55:00 AM on December 21,

20162016 , based on the specified custom format and culture.

However, DATETIMEVALUE ("21-Gen-2016 02:55:00", "dd-MMM-yyyy hh:mm:ss", "EN-US")  throws an exception to

inform the user that the specified string isn't recognized as a valid date/time value for the specified culture.

Date and time functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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DATETODATETIME ER function
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Syntax

DATETODATETIME (date)

Arguments

Return values

Example 1

Example 2

Additional resources

NOTENOTE

The DATETODATETIME  function returns a DateTime value that is converted from a given date value to a date/time

value in Coordinated Universal Time (Greenwich Mean Time [GMT]).

date : Date

A date value that represents the date to convert.

DateTime

The resulting date/time value.

DATETODATETIME (CompInfo. 'getCurrentDate()')  returns the date of the current Microsoft Dynamics 365 Finance

session, December 24, 2015, as 12/24/2015 12:00:00 AM12/24/2015 12:00:00 AM. In this example, CompInfoCompInfo is an Electronic

reporting (ER) data source of the Finance and Operations/TableFinance and Operations/Table type, and it refers to the CompanyInfo table.

DATETODATETIME (DATEVALUE ("2019-11-12T16:00:00.0000000-07:00", "O"))  returns the date/time value

11/12/2019 12:00:00 AM11/12/2019 12:00:00 AM.

Date and time functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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DATEVALUE ER function
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Syntax 1

DATEVALUE (text, format)

Syntax 2

DATEVALUE (text, format, culture)

Arguments

Return values

Usage notes

Example 1

Example 2

The DATEVALUE  function returns a Date value that is converted from a given text value in the specified format

and in an optionally specified culture to a date value. For information about the supported formats, see standard

and custom.

text : String

Text that represents the value to format.

format : String

The format of the given text.

culture : String

The culture that is used for formatting of the given text.

Date

The resulting date value.

When the culture isn't defined as an argument of the called function, the value of culture  is defined by the

calling context. For example, if the DATEVALUE  function is called by using syntax 1 in an Electronic reporting (ER)

format for a FILEFILE element that is configured to use the German culture, the conversion will be done by using the

German culture. The default culture  value is EN-USEN-US .

DATEVALUE ("21-Dec-2016", "dd-MMM-yyyy")  returns the date value December 21, 2016December 21, 2016 , based on the specified

custom format and the default application's EN-USEN-US  culture.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-datetime-datevalue.md
https://docs.microsoft.com/en-us/bingmaps/rest-services/common-parameters-and-types/supported-culture-codes
https://msdn.microsoft.com/library/az4se3k1(v=vs.110).aspx
https://msdn.microsoft.com/library/8kb3ddd4(v=vs.110).aspx


Additional resources

NOTENOTE

DATEVALUE ("21-Gen-2016", "dd-MMM-yyyy", "IT")  returns the date value Januar y 21, 2016Januar y 21, 2016 , based on the

specified custom format and culture.

However, DATEVALUE ("21-Gen-2016", "dd-MMM-yyyy", "EN-US")  throws an exception to inform the user that the

specified string isn't recognized as a valid date for the specified culture.

Date and time functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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DAYOFYEAR ER function
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Syntax

DAYOFYEAR (date) as Integer

Arguments

Return values

Example 1

Example 2

Additional resources

NOTENOTE

The DAYOFYEAR  function returns an Integer value that represents the number of days between January 1 and the

specified date.

date : Date

A date value that represents the date to use for the calculation of the number of days.

Integer

The resulting numeric value.

DAYOFYEAR (DATEVALUE ("01-03-2016", "dd-MM-yyyy"))  returns 6161 .

DAYOFYEAR (DATEVALUE ("01-01-2016", "dd-MM-yyyy"))  returns 11 .

Date and time functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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DAYS ER function
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Syntax

DAYS (date 1, date 2) as Integer

Arguments

Return values

Usage notes

Example

Additional resources

NOTENOTE

The DAYS  function returns an Integer value that represents the number of days between one specified date and

a second specified date.

date 1 : Date

A date value that represents the start date for the calculation of the number of days.

date 2 : Date

A date value that represents the end date for the calculation of the number of days.

Integer

The resulting numeric value.

The DAYS  function returns a positive value when the first date is later than the second date, it returns 00  (zero)

when the first date equals the second date, and it returns a negative value when the first date is earlier than the

second date.

DAYS (TODAY (), DATEVALUE( DATETIMEFORMAT( ADDDAYS ( NOW(), 1), "yyyyMMdd"), "yyyyMMdd"))  returns -1-1 .

Date and time functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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NOW ER function
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Syntax

NOW ()

Return values

Example

Additional resources

NOTENOTE

The NOW  function returns a DateTime value that represents the current application server date and time.

DateTime

The resulting date/time value.

DATETIMEFORMAT (NOW(), "dd-MM-yyyy")  returns the current application server date/time value, December 24,

2015, as "24-12-2015""24-12-2015", based on the specified custom format.

Date and time functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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NULLDATE ER function
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Syntax

NULLDATE () as 

Return values

Example 1

Example 2

Additional resources

NOTENOTE

The NULLDATE  function returns a Date value that represents the nullnull  date (January 1, 1900).

Date

The resulting date value.

DATEFORMAT (NULLDATE(), "yyyy-MM-dd")  returns the nullnull  date, January 1, 1900, as "1900-01-01""1900-01-01", based on the

specified custom format.

The expression IF( Invoice.DocumentDate = NULLDATE(), true, false)  returns TrueTrue when the value of the

DocumentDateDocumentDate field equals the nullnull  date. In this example, InvoiceInvoice is an Electronic reporting (ER) data source

of the Finance/Table recordsFinance/Table records  type, and it refers to the CustInvoiceJour table.

Date and time functions
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NULLDATETIME ER function
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Syntax

NULLDATETIME ()

Return values

Example

Additional resources

NOTENOTE

The NULLDATETIME  function returns a DateTime value that represents the nullnull  date/time value (January 1, 1900)

in Coordinated Universal Time (Greenwich Mean Time [GMT]).

DateTime

The resulting date/time value.

DATETIMEFORMAT( NULLDATETIME(), "O")  returns the string value 1900-01-01T00:00:00.0000000+00:001900-01-01T00:00:00.0000000+00:00

when it's called during a process that was initiated by an application user who has the time zone value (GMT)(GMT)

Coordinated Universal TimeCoordinated Universal Time in the Language and countr y/region preferencesLanguage and countr y/region preferences  section.

Date and time functions
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SESSIONNOW ER function
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Syntax

SESSIONNOW ()

Return values

Example

Additional resources

NOTENOTE

The SESSIONNOW  function returns a DateTime value that represents the current application session date and time.

DateTime

The resulting date/time value.

DATETIMEFORMAT (SESSIONNOW(), "d", "DE")  returns the current application session date/time value, December

24, 2015, as "24.12.2015""24.12.2015", based on the selected German culture and the specified format.

Date and time functions
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SESSIONTODAY ER function
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Syntax

SESSIONTODAY ()

Return values

Example

Additional resources

NOTENOTE

The SESSIONTODAY  function returns a Date value that represents the current application session date.

Date

The resulting date value.

DATEFORMAT (SESSIONTODAY (), "d", "DE")  returns the current application session date, December 24, 2015, as

the string "24-12-2015""24-12-2015", based on the selected German culture and the specified format.

Date and time functions
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List of supported functions

F UN C T IO NF UN C T IO N DESC RIP T IO NDESC RIP T IO N

AllItems This function runs as an in-memory selection. It returns a
new flattened Record list value that consists of a list of
records that represents all items that match the specified
path.

AllItemsQuery This function runs as a joined SQL query. It returns a new
flattened Record list value that consists of a list of records
that represents all items that match the specified path.

Count This function returns an Integer value that represents the
number of records in the specified list, if the list isn't empty.
If the list is empty, this function returns 00  (zero).

EmptyList This function returns an empty Record list value by using the
specified list as a source for the list structure.

Enumerate This function returns a new Record list value that consists of
enumerated records of the specified list.

Filter This function returns the specified list as a Record list value
after the query has been changed so that it filters for the
specified condition.

First This function returns the first record of the specified list as a
Container (record) value, if that list isn't empty. If the list is
empty, this function throws an exception.

FirstOrNull This function returns the first record of the specified list as a
Container (record) value, if that record isn't empty. If the
record is empty, this function returns a null Container
(record) value.

Index This function returns a Container (record) value that is
selected by using the specified numeric index in the specified
list. If the index is out of range for the records in the
specified list, this function throws an exception.

IsEmpty This function returns a Boolean value of TRUETRUE if the
specified list contains no records. Otherwise, it returns a
Boolean value of FALSEFALSE.

List This function returns a Record list value that consists of a
new list that is created from the specified arguments.

Electronic reporting (ER) list functions can be used to extract information from, and perform operations on, data

sources of the Record list and Container (record) data types. This topic provides a summary of these functions.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-category-list.md


ListDistinct This function calculates the specified expression as a selector
for every record of the specified list. It returns a new Record
list value that contains a single record for each unique
selector value.

ListJoin This function returns a Record list value that represents a
new joined list that is created from the specified arguments.

ListOfFields This function returns a Record list value that is created based
on the structure of the specified argument of the
Enumeration or Container (record) type.

ListOfFirstItem This function returns a Record list value that consists of only
the first record of the specified list.

OrderBy This function returns the specified list as a Record list value
after it has been sorted according to the specified
arguments. These arguments can be defined as expressions.

Reverse This function returns the specified list as a Record list value in
reversed sort order.

Split This function splits the specified input string into substrings
and returns the result as a new Record list value.

SplitList This function splits the specified list into sublists (or batches),
each of which contains the specified number of records. It
then returns the result as a new Record list value that
consists of the batches.

SplitListByLimit This function splits the specified list into a new list of sublists
(batches). The number of records in each batch is
dynamically calculated. The function then returns the result
as a new Record list value that consists of the batches.

StringJoin This function returns a String value that consists of
concatenated values of the specified field from the specified
list. The values can be separated by the specified delimiter.

Where This function returns the specified list as a Record list value
after it has been filtered according to the specified condition.

F UN C T IO NF UN C T IO N DESC RIP T IO NDESC RIP T IO N

Additional resources

NOTENOTE

Electronic Reporting overview

Formula designer in Electronic reporting

Electronic reporting formula language
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ALLITEMS ER function
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Syntax

ALLITEMS (path)

Arguments

Return values

Usage notes

Example 1

Example 2

Additional resources

The ALLITEMS  function runs as an in-memory selection and returns a new flattened Record list value as a list of

records that represents all items that match the specified path.

path : Record list

The valid path of a data source of the Record list data type.

Record list

The resulting list of records.

The path must be defined as a valid data source path of a data source element of the Record list data type. Data

elements such as the path string and date should raise an error in the Electronic reporting (ER) expression

builder at design time.

We don't recommend that you use this function for transactional data sources that might contain a large volume

of data. Instead, consider using the ALLTEMSQUERY function.

If you enter SPLIT("abcdef" , 2)  as data source DSDS , the expression COUNT( ALLITEMS (DS))  returns 33 .

If you enter VendVend as the data source of the Record list data type that refers to the VendTable application table,

the expression ALLITEMS (Vend.'<Relations'.ContactPerson)  returns a flattened list of records that has the

ContactPersonContactPerson table structure and contains all contact persons that can be accessed by using the

ContactPerson.ContactForPar ty == VendTable.Par tyContactPerson.ContactForPar ty == VendTable.Par ty  relation, and that is available for all vendors from the

referenced vendor table.

List functions

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-list-allitems.md
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ALLITEMSQUERY ER function
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Syntax

ALLITEMSQUERY (path)

Arguments

Return values

Usage notes

Example

SELECT ... FROM CUSTINVOICETABLE T1 CROSS JOIN CUSTINVOICEJOUR T2 CROSS JOIN
CUSTINVOICETRANS T3 WHERE...

Additional resources

The ALLITEMSQUERY  function runs as a joined SQL query. It returns a new flattened Record list value that consists

of a list of records that represent all items that match the specified path.

path : Record list

The valid path of a data source of the Record list data type. It must contain at least one relation.

Record list

The resulting list of records.

The specified path must be defined as a valid data source path of a data source element of the Record list data

type. It must also contain at least one relation. Data elements such as the path String and Date should raise an

error in the Electronic reporting (ER) expression builder at design time.

When this function is applied to data sources of the Record list data type that refer to an application object that

can be directly called by using SQL (for example, an table, entity, or query), it runs as a joined SQL query.

Otherwise, it runs in memory as the ALLITEMS function.

You define the following data sources in your model mapping:

A CustInvCustInv  data source of the Table records type that refers to the CustInvoiceTable table

A FilteredInvFilteredInv  data source of the Calculated field type that contains the expression 

FILTER (CustInv, CustInv.InvoiceAccount = "US-001")

A JourLinesJourLines  of the Calculated field type that contains the expression 

ALLITEMSQUERY ( FilteredInv.'<Relations'.CustInvoiceJour.'<Relations'.CustInvoiceTrans)

When you run the model mapping to call the JourLinesJourLines  data source, the following SQL statement is run:

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-list-allitemsquery.md
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List functions
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Syntax

COUNT (list)

Arguments

Return values

Example

Additional resources

NOTENOTE

The COUNT  function returns an Integer value that represents the number of records in the specified list, if the list

isn't empty. If the list is empty, this function returns 00  (zero).

list : Record list

The valid path of a data source of the Record list data type.

Integer

The resulting numeric value.

COUNT (SPLIT("abcd" , 3))  returns 22 , because the SPLIT  function that is used in this example creates a list that

consists of two records.

List functions
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EMPTYLIST ER function
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Syntax

EMPTYLIST (list)

Arguments

Return values

Example

Additional resources

NOTENOTE

The EMPTYLIST  function returns an empty Record list value by using the specified list as a source for the list

structure.

list : Record list

The valid path of a data source of the Record list data type.

Record list

The resulting list of records.

EMPTYLIST (SPLIT ("abc", 1))  returns a new empty list that has the same structure as the list that is returned by

the SPLIT  function that is used.

List functions
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ENUMERATE ER function
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Syntax

ENUMERATE (list)

Arguments

Return values

Usage notes

Example

The ENUMERATE  function returns a new Record list value that consists of enumerated records of the specified list.

list : Record list

The valid path of a data source of the Record list data type.

Record list

The resulting list of records.

The list of enumerated records that is returned exposes the following additional elements:

The record of fields (ValueValue component)

The current record index (NumberNumber  component)

In the following illustration, an EnumeratedEnumerated data source is created as an enumerated list of vendor records

from the VendorsVendors  data source that refers to the VendTable table.

The following illustration shows the Electronic reporting (ER) format. In this format, data bindings are created to

generate output in XML format. This output presents individual vendors as enumerated nodes.

The following illustration shows the result when the designed format is run.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-list-enumerate.md
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Additional resources

NOTENOTE
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Syntax

FILTER (list, condition)

Arguments

Return values

Usage notes

Example 1

Example 2

Example 3

The FILTER  function returns the specified list as a Record list value after the query has been changed so that it

filters for the specified condition.

list : Record list

The valid path of a data source of the Record list data type.

condition : Boolean

A valid conditional expression that is used to filter records of the specified list.

Record list

The resulting list of records.

This function differs from the WHERE function, because the specified condition is applied to any Electronic

reporting (ER) data source of the Table records type at the database level. The list and condition can be defined

by using tables and relations.

If one or both arguments that are configured for this function ( list  and condition ) don't allow this request to

be translated to the direct SQL call, an exception is thrown at design time. This exception informs the user that

either list  or condition  can't be used to query the database.

If VendorVendor  is configured as an ER data source that refers to the VendTable table, the expression 

FILTER (Vendors, Vendors.VendGroup = "40")  returns a list of only vendors that belong to vendor group 40.

If VendorVendor  is configured as an ER data source that refers to the VendTable table, and if parmVendorBankGroupparmVendorBankGroup

is configured as an ER data source that returns a value of the String data type, the expression 
FILTER ( Vendor.'<Relations'.VendBankAccount, Vendor.'<Relations'.VendBankAccount.BankGroupID =
parmVendorBankGroup)

returns a list of only vendor accounts that belong to a specific bank group.
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Additional resources

NOTENOTE

You enter data source DSDS  of the Calculated field type, and it contains the expression SPLIT ("A,B,C", ",") . You

then enter another expression, FILTER( DS, DS.Value = "B") . When you try to save this expression in the ER

formula designer, the following exception is thrown: "Validation error : The list expression of FILTER function is

not queryable."

List functions
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FIRST ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

FIRST (list)

Arguments

Return values

Example 1

Example 2

Additional resources

NOTENOTE

The FIRST  function returns the first record of the specified list as a Container (record) value, if that list isn't

empty. If the list is empty, this function throws an exception.

list : Record list

The valid path of a data source of the Record list data type.

Container (record)

The resulting record value.

The expression FIRST(SPLIT("ABC",1)).Value  returns the text value "A""A".

The expression FIRST(SPLIT("",1)).Value  throws an exception at runtime.

List functions
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FIRSTORNULL ER function
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Syntax

FIRSTORNULL (list)

Arguments

Return values

Example

Additional resources

NOTENOTE

The FIRSTORNULL  function returns the first record of the specified list as a Container (record) value, if that record

isn't empty. If the record is empty, this function returns a null Container (record) value.

list : Record list

The valid path of a data source of the Record list data type.

Container (record)

The resulting record value.

The expression FIRSTORNULL(SPLIT("",1)).Value  returns an empty string ("""").

List functions
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INDEX ER function
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Syntax

INDEX (list, index)

Arguments

Return values

Example 1

Example 2

Additional resources

NOTENOTE

The INDEX  function returns a Container (record) value that is selected by using the specified numeric index in

the specified list. If the index is out of range for the records in the specified list, an exception is thrown.

list : Record list

The valid path of a data source of the Record list data type.

index : Integer

A numeric index that indicates the position of the desired record in the specified list.

Container (record)

The resulting record value.

If you enter data source DSDS  of the Calculated field type, and it contains the expression SPLIT ("A|B|C", "|") , the

expression DS.Value  returns the text value "B""B" for the second record of this record list. The expression 

INDEX (SPLIT ("A|B|C", "|"), 2).Value  also returns the text value "B""B".

If you enter data source DSDS  of the Calculated field type, and it contains the expression SPLIT ("A|B|C", "|") , the

expression INDEX (SPLIT ("A|B|C", "|"), 4).Value  throws an exception at runtime.

List functions
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ISEMPTY ER function
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Syntax

ISEMPTY (list)

Arguments

Return values

Example 1

Example 2

Additional resources

NOTENOTE

The ISEMPTY  function returns a Boolean value of TRUETRUE if the specified list contains no records. Otherwise, it

returns a Boolean value of FALSEFALSE.

list : Record list

The valid path of a data source of the Record list data type.

Boolean

The resulting Boolean value.

If you enter data source DSDS  of the Calculated field type, and it contains the expression SPLIT ("A|B|C", "|") , the

expression ISEMPTY(DS)  returns FALSEFALSE.

The expression ISEMPTY (SPLIT ("",1))  returns TRUETRUE.
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LIST ER function
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Syntax

LIST (record 1 [, record 2, …, record N])

Arguments

Return values

Usage notes

Example

Additional resources

The LIST  function returns a Record list value that consists of a new list of records that is created from the

specified arguments.

record 1 : Container (record)

A reference to a data source of the Record data type. This argument is required.

record N : Container (record)

A reference to a data source of the Record data type. These additional arguments are optional.

Record list

The resulting list of records.

The structure of the list that is created contains only the fields that are presented in the structure of every record

that is mentioned in the arguments.

You enter data source Record 1Record 1  of the Container type. This data source contains the following nested fields of

the Calculated field type:

Code:Code: This field contains an expression that returns a value of the String type.

Amount:Amount: This field contains an expression that returns a value of the Real type.

You then enter data source Record 2Record 2  of the Container type. This data source contains the following nested fields

of the Calculated field type:

Amount:Amount: This field contains an expression that returns a value of the Real type.

IsValid:IsValid: This field contains an expression that returns a value of the Boolean type.

In this case, the expression LIST('Record 1', 'Record 2')  returns a new list that contains two records. The

structure of this list consists of a single AmountAmount field of the Real type, because this field is the only field that is

presented in every argument of the called function.
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LISTJOIN ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

LIST (list 1 [, list 2, …, list N])

Arguments

Return values

Usage notes

Example

The LISTJOIN  function returns a Record list value that represents a new joined list of records that is created

from the specified arguments.

list 1 : Record list

A reference to a data source of the Record list data type. This argument is mandatory.

list N : Record list

A reference to a data source of the Record list data type. These additional arguments are optional.

Record list

The resulting list of records.

The structure of the list that is created contains only the fields that are present in the structure of every record

list that is referenced in the arguments.

You enter data source Record 1Record 1  of the Container  type. This data source contains the following nested fields of

the Calculated field  type:

CodeCode: This field contains an expression that returns a value of the String  type.

AmountAmount: This field contains an expression that returns a value of the Real  type.

You then enter data source Record 2Record 2  of the Container  type. This data source contains the following nested

fields of the Calculated field  type:

AmountAmount: This field contains an expression that returns a value of the Real  type.

IsValidIsValid: This field contains an expression that returns a value of the Boolean  type.
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In this case, the expression LISTJOIN(LIST('Record 1'), LIST('Record 2'))  returns a new list that contains two

records.

The structure of this list consists of a single AmountAmount field of the Real  type, because this field is the only field

that is presented in every argument of the called function.



Additional resources
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LISTOFFIELDS ER function
2/18/2021 • 3 minutes to read • Edit Online

Syntax 1

LISTOFFIELDS (path)

Syntax 2

LISTOFFIELDS (path, language)

Arguments

Return values

Usage notes

The LISTOFFIELDS  function returns a Record list value that is created based on the structure of the specified

argument of the Enumeration or Container (record) type.

path : Data source reference

The valid reference path of a data source of one of the following data types:

Model enumeration

Format enumeration

Application enumeration

Container (record)

language : String

Text that represents a language code.

Record list

The resulting list of records.

The list that is created consists of records that have the following fields:

NameName (String data type)

LabelLabel  (String data type)

Descr iptionDescr iption (String data type)

IsTranslatedIsTranslated (Boolean data type)

If the path  argument refers to a data source of the Container (Record) type, for every field of the referenced

container record, a new record is added to the list that is created. For every record that is created, the NameName

field returns the name of the field of the referenced container record that the current record was created for.

If the path  argument refers to a data source of one of the Enumeration types, for every enumeration value of
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Example 1

the referenced enumeration, a new record is added to the list that is created. For every record that is created, the

NameName field returns the value of the referenced enumeration that the current record was created for, the

Descr iptionDescr iption field returns the description of that enumeration, and the LabelLabel  field returns the label of that

enumeration.

At runtime, when syntax 1 is used, the LabelLabel  and Descr iptionDescr iption fields must return values that are based on the

language settings of the Electronic reporting (ER) format that is running:

If the labels and descriptions for the requested language are available, the LabelLabel  and Descr iptionDescr iption fields

return values that are based on that language, and the IsTranslatedIsTranslated field returns TrueTrue.

If the labels and descriptions for the requested language aren't available, the LabelLabel  and Descr iptionDescr iption fields

return values that are based on the default EN-USEN-US  language, and the IsTranslatedIsTranslated field returns FalseFalse.

At runtime, when syntax 2 is used, the LabelLabel  and Descr iptionDescr iption fields must return values that are based on the

language that is defined as the second argument of the called function:

If the labels and descriptions for the requested language are available, the LabelLabel  and Descr iptionDescr iption fields

return values that are based on that language, and the IsTranslatedIsTranslated field returns TrueTrue.

If the labels and descriptions for the requested language aren't available, the LabelLabel  and Descr iptionDescr iption fields

return values that are based on the EN-USEN-US  language, and the IsTranslatedIsTranslated field returns FalseFalse.

In the following illustration, an enumeration is introduced in an ER data model.

The following illustration shows these details:

The model enumeration is inserted into a report as a data source.

An ER expression uses the model enumeration as a parameter of the LISTOFFIELDS  function.

A data source of the Record list type is inserted into a report by using the ER expression that is created.

The following example shows the ER format elements that are bound to the data source of the Record list type

that was created by using the LISTOFFIELDS  function.
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NOTENOTE

Example 2

IF (NOT (enumType_deCH.IsTranslated), enumType_de.Label, enumType_deCH.Label)

Additional resources

NOTENOTE

The following illustration shows the result when the designed format is run.

Based on the language settings of the parent FILEFILE and FOLDERFOLDER format elements, translated text for labels and

descriptions is entered in the output of the ER format.

You use the Calculated field data source type to configure enumType_deenumType_de and enumType_deCHenumType_deCH data sources

for the enumTypeenumType data model enumeration:

enumType_deenumType_de = LISTOFFIELDS (enumType, "de")

enumType_deCHenumType_deCH = LISTOFFIELDS (enumType, "de-CH")

In this case, you can use the following expression to get the label of the enumeration value in Swiss German, if

that translation is available. If the Swiss German translation isn't available, the label is in German.

List functions
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LISTOFFIRSTITEM ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

LISTOFFIRSTITEM (list)

Arguments

Return values

Example

Additional resources

NOTENOTE

The LISTOFFIRSTITEM  function returns a Record list value that consists of only the first record of the specified list.

list : Record list

The valid path of a data source of the Record list data type.

Record list

The resulting list of records.

The expression FIRST( LISTOFFIRSTITEM ( SPLIT ("ABC",1))).Value  returns the text value "A""A".

List functions
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ORDERBY ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

ORDERBY (list , expression 1[, expression 2, …, expression N])

Arguments

Return values

Example 1

Example 2

Additional resources

The ORDERBY  function returns the specified list as a Record list value after it has been sorted according to the

specified arguments. These arguments can be defined as expressions.

list : Record list

The valid path of a data source of the Record list data type.

expression 1 : Field

The valid path of a field of the data source that is referenced by the list  argument of the called function. The

referenced field must be a field of the primitive data type. This argument is required.

expression N : Field

The valid path of a field of the data source that is referenced by the list  argument of the called function. The

referenced field must be a field of the primitive data type. These additional arguments are optional.

Record list

The resulting list of records.

If you enter data source DSDS  of the Calculated field type, and it contains the expression SPLIT ("C|B|A", "|") , the

expression FIRST( ORDERBY( DS, DS. Value)).Value  returns the text value "A""A".

If VendorVendor  is configured as an Electronic reporting (ER) data source that refers to the VendTable table, the

expression ORDERBY (Vendors, Vendors.'name()')  returns a list of vendors that is sorted by name in ascending

order.

List functions
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REVERSE ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

REVERSE (list)

Arguments

Return values

Example 1

Example 2

Additional resources

NOTENOTE

The REVERSE  function returns the specified list as a Record list value in reversed sort order.

list : Record list

The valid path of a data source of the Record list data type.

Record list

The resulting list of records.

If you enter data source DSDS  of the Calculated field type, and it contains the expression SPLIT ("C|B|A", "|") , the

expression FIRST( REVERSE( ORDERBY( DS, DS. Value))).Value  returns the text value "C""C".

If VendorVendor  is configured as an Electronic reporting (ER) data source that refers to the VendTable table, the

expression REVERSE (ORDERBY (Vendors, Vendors.'name()'))  returns a list of vendors that is sorted by name in

descending order.
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SPLIT ER function
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Syntax 1

SPLIT (input, length)

Syntax 2

SPLIT (input, delimiter)

Arguments

Return values

Usage notes

Example 1

The SPLIT  function splits the specified input string into substrings and returns the result as a new Record list

value.

This syntax is used to split the specified input string into substrings, each of which has the specified length.

This syntax is used to split the specified input string into substrings, based on the specified delimiter.

input : String

The text to split.

length : Integer

The maximum length of a single substring.

delimiter : String

A delimiter that is used to separate substrings.

Record list

The resulting list of records.

The record structure of the list that is returned consists of the ValueValue field of the String type. Every record of the

list that is returned contains generated substrings in this field.

If the delimiter  argument is empty, the new list that is returned consists of one record that has the ValueValue field

of the String type. This field contains the input text.

If the input  argument is empty, a new empty list is returned. If either the input  or delimiter  argument is

unspecified (null), an application exception is thrown.
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Example 2

Additional resources

NOTENOTE

SPLIT ("abcd", 3)  returns a new list that consists of two records that have the ValueValue field of the String type.

The ValueValue field in the first record contains the text "abc""abc", and the ValueValue field in the second record contains the

text "d""d".

SPLIT ("XAb aBy", "aB")  returns a new list that consists of three records that have the ValueValue field of the String

type. The ValueValue field in the first record contains the text "X""X", the ValueValue field in the second record contains the

text " "" ", and the ValueValue field in the third record contains the text "y""y".

List functions
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SPLITLIST ER function
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Syntax

SPLITLIST (list, number)

Arguments

Return values

Usage notes

Example

The SPLITLIST  function splits the specified list into sublists (or batches), each of which contains the specified

number of records. It then returns the result as a new Record list value that consists of the batches.

list : Record list

The valid path of a data source of the Record list data type.

number : Integer

The maximum number of records per batch.

Record list

The resulting list of records.

The list of batches that is returned contains the following elements:

Value:Value: List

The list of records that belong to the current batch.

BatchNumber :BatchNumber : Integer

The number of the current batch in the returned list.

In the following illustration, a L inesLines  data source is created as a record list that has three records. This list is

divided into batches, each of which contains up to two records.

The following illustration shows the designed format layout. In this format layout, bindings to the L inesLines  data

source are created to generate output in XML format. This output presents individual nodes for each batch and

the records in it.
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Additional resources
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The following illustration shows the result when the designed format is run.
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SPLITLISTBYLIMIT ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

SPLITLISTBYLIMIT (list, limit value, limit source)

Arguments

Return values

Usage notes

Example

The SPLITLISTBYLIMIT  function splits the specified list into a new list of sublists (batches). The number of records

in each batch is dynamically calculated. The function then returns the result as a new Record list value that

consists of the batches.

list : Record list

The valid path of a data source of the Record list data type.

limit value : Integer or Real

The maximum value of the limit that is used to split the original list into batches.

limit source : Field

The valid path of a field of the Integer or Real type in the specified list. The value of this field defines the step that

the total sum is increased on.

Record list

The resulting list of records.

The list of batches that is returned contains the following elements:

ValueValue: List

The list of records that belong to the current batch.

BatchNumberBatchNumber : Integer

The number of the current batch in the returned list.

The limit isn't applied to a single item of the original list if the limit source exceeds the defined limit.

The following illustration shows an Electronic reporting (ER) format.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-list-splitlistbylimit.md


The following illustration shows the data sources that are used for the format.

The following illustration shows the result when the format is run. In this case, the output is a flat list of

commodity items.

In the following illustrations, the same format has been adjusted so that it presents the list of commodity items

in batches if a single batch must include commodities and the total weight should not exceed a limit of 9.
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The following illustration shows the result when the adjusted format is run.
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NOTENOTE

Additional resources

NOTENOTE

The limit isn't applied to the last item of the original list, because the value (1111 ) of the limit source (weightweight ) exceeds the

defined limit (99 ). To ignore sublists during report generation, use either the WHERE  function or the EnabledEnabled expression of

the corresponding format element, as you require.
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STRINGJOIN ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

STRINGJOIN (list, field, delimiter)

Arguments

Return values

Example

Additional resources

NOTENOTE

The STRINGJOIN  function returns a String value that consists of concatenated values of the specified field from

the specified list. The values can be separated by the specified delimiter.

list : Record list

The valid path of a data source of the Record list data type.

field : Field

The valid path of a field of the String data type in the specified list.

delimiter : String

A delimiter that is used to separate substrings.

String

The resulting text value.

If you enter SPLIT("abc" , 1)  as data source DSDS , the expression STRINGJOIN (DS, DS.Value, "-")  returns "a-b-"a-b-

c"c".

List functions
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WHERE ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

WHERE (list, condition)

Arguments

Return values

Usage notes

Example 1

Example 2

Additional resources

The WHERE  function returns the specified list as a Record list value after it has been filtered according to the

specified condition.

list : Record list

The valid path of a data source of the Record list data type.

condition : Boolean

A valid conditional expression that is used to filter records of the specified list.

Record list

The resulting list of records.

This function differs from the FILTER function, because the specified condition is applied to any Electronic

reporting (ER) data source of the Record list type that is present in memory.

If the arguments that are configured for this function ( list  and condition ) allow this request to be translated

to the direct SQL call, a warning message is thrown at design time. This message informs the user that

performance might be improved if the FILTER function is used instead of WHERE .

If VendorVendor  is configured as an ER data source that refers to the VendTable table, the expression 

WHERE (Vendors, Vendors.VendGroup = "40")  returns a list of only vendors that belong to vendor group 40.

If you enter data source DSDS  of the Calculated field type, and it contains the expression SPLIT ("A|B|C", "|") , the

expression WHERE( DS, DS.Value = "B")  returns a list of only one record that contains the text "B""B" in the ValueValue

field.

List functions
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List of ER functions in the logical category
2/18/2021 • 2 minutes to read • Edit Online

List of supported functions

F UN C T IO NF UN C T IO N DESC RIP T IO NDESC RIP T IO N

And This function returns a Boolean value of TRUETRUE if all the
specified conditions are true. Otherwise, it returns a Boolean
value of FALSEFALSE.

Case This function evaluates the value of the specified expression
against the specified alternative options and returns the
result of the first option that equals the value of the
specified expression. Otherwise, it returns an optional default
result, if a default result is specified as the last argument of
the called function that isn't preceded by an option. The
value that is returned can be a value of any of the supported
data types.

If This function returns the first specified value if the specified
condition is met. Otherwise, it returns the second specified
value. The value that is returned can be a value of any of the
supported data types.

Not This function returns the reversed logical value of the
specified condition as a Boolean value.

Or This function returns a Boolean value of FALSEFALSE if all the
specified conditions are false. If any specified condition is
true, the function returns a Boolean value of TRUETRUE.

ValueIn This function determines whether the specified input
matches any value of a specified item in the specified list. It
returns a Boolean value of TRUETRUE if the specified input
matches the result of running the specified expression for at
least one record of the specified list. Otherwise, it returns a
Boolean value of FALSEFALSE.

ValueInLarge This function determines whether the specified input of the
Int64 or Integer type matches any value of a specified item
in the specified list. It returns a Boolean value of TRUETRUE if the
specified input matches the result of running the specified
expression for at least one record of the specified list.
Otherwise, it returns a Boolean value of FALSEFALSE.

Additional resources

Electronic reporting (ER) logical functions can be used to work with logical values to perform more than one

comparison in a single expression or test multiple conditions. This topic provides a summary of these functions.

Electronic Reporting overview

Formula designer in Electronic reporting
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AND ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

AND (condition 1[, condition 2, …, condition N])

Arguments

Return values

Usage notes

Example

Additional resources

NOTENOTE

The AND  function returns a Boolean value of TRUETRUE if all the specified conditions are true. Otherwise, it returns a

Boolean value of FALSEFALSE.

condition 1 : Boolean

A valid conditional expression that must be tested. This argument is required.

condition N : Boolean

A valid conditional expression that must be tested. These additional arguments are optional.

Boolean

The resulting Boolean value.

In the arguments of logical functions, you can use data source references, numeric and text values, Boolean

values, comparison operators, and other Electronic reporting (ER) functions. However, all the arguments must be

evaluated to a Boolean value of TRUETRUE or FALSEFALSE.

AND (1=1, "a"="a")  returns TRUETRUE.

AND (1=2, "a"="a")  returns FALSEFALSE.

Logical functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-logical-and.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


CASE ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

CASE (expression, option 1, result 1[, option 2, result 2, …, option N, result N, default result])

Arguments

Return values

Usage notes

The CASE  function evaluates the value of the specified expression against the specified alternative options and

returns the result of the first option that equals the value of the specified expression. Otherwise, it returns the

optional default result, if a default result is specified as the last argument of the called function that isn't

preceded by an option. The value that is returned can be a value of any of the supported data types.

expression : Primitive data type (Boolean, numeric, or text)

A valid expression that returns a value of the primitive data type.

option 1 : Primitive data type (Boolean, numeric, or text)

A valid expression that returns a value of the same primitive data type as the expression  argument of the called

function. This argument is required.

result 1 : Any of the supported data types

The returned result that corresponds to the preceding option. This argument is required.

option N : Primitive data type (Boolean, numeric, or text)

A valid expression that returns a value of the same primitive data type as the expression  argument of the called

function. This argument is optional.

result N : Any of the supported data types

The returned result that corresponds to the preceding option. This argument is optional.

default result : Any of the supported data types

The result that should be returned if there is no match. This argument is optional.

Any of the supported data types

The resulting value of any of the supported data types.

An exception is thrown at runtime if there is no match and an optional default result isn't defined.

All results must be specified by using the same data type. An exception is thrown at design time if the data types

of the configured results don't match.

If the first result value and the Nth result value are values of the Container (record) or Record list data type, the

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-logical-case.md


Example

Additional resources

NOTENOTE

result has only the fields that exist in both values.

CASE( DATETIMEFORMAT( NOW(), "MM"), "10", "WINTER", "11", "WINTER", "12", "WINTER", "")  returns the string

"WINTER""WINTER" if the current application session date is between October and December. Otherwise, it returns a

blank string.

Logical functions
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IF ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

IF (condition, first value, second value) as any of the supported data types

Arguments

Return values

Usage notes

Example

Additional resources

NOTENOTE

The IF  function returns the first specified value if the specified condition is met. Otherwise, it returns the

second specified value. The value that is returned can be a value of any of the supported data types.

condition : Boolean

A valid conditional expression that must be tested.

first value : Any of the supported data types

The result that is returned if the condition is met.

second value : Any of the supported data types

The result that is returned if the condition isn't met.

Any of the supported data types

The resulting value of any of the supported data types.

The first value  and second value  arguments must be specified by using the same data type. An exception is

thrown at design time if the data types of the configured values don't match.

If the first value and the second value are values of the Container (record) or Record list data type, the result has

only the fields that exist in both values.

IF (1=2, "condition is met", "condition is not met")  returns the string "condition is not met""condition is not met".

Logical functions
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NOT ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

NOT (condition)

Arguments

Return values

Example

Additional resources

NOTENOTE

The NOT  function returns the reversed logical value of the specified condition as a Boolean value.

condition : Boolean

A valid conditional expression that must be reversed.

Boolean

The resulting Boolean value.

NOT (TRUE)  returns FALSEFALSE.

Logical functions
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OR ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

OR (condition 1[, condition 2, …, condition N])

Arguments

Return values

Example

Additional resources

NOTENOTE

The OR  function returns a Boolean value of FALSEFALSE if all the specified conditions are false. If any specified

condition is true, the function returns a Boolean value of TRUETRUE.

condition 1 : Boolean

A valid conditional expression that must be tested. This argument is required.

condition N : Boolean

A valid conditional expression that must be tested. These additional arguments are optional.

Boolean

The resulting Boolean value.

OR (1=2, "a"="a")  returns TRUETRUE.

Logical functions
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VALUEIN ER function
2/18/2021 • 3 minutes to read • Edit Online

Syntax

VALUEIN (input, list, list item expression)

Arguments

Return values

Usage notes

(input = list.item1.value) OR (input = list.item2.value) OR …

Example 1

The VALUEIN  function determines whether the specified input matches any value of a specified item in the

specified list. It returns a Boolean value of TRUETRUE if the specified input matches the result of running the specified

expression for at least one record of the specified list. Otherwise, it returns a Boolean value of FALSEFALSE.

input : Field

The valid path of an item of a data source of the Record list type. The value of this item will be matched.

list : Record list

The valid path of a data source of the Record list data type.

list item expression : Boolean

A valid conditional expression that either points to or contains a single field of the specified list that should be

used for the matching.

Boolean

The resulting Boolean value.

In general, the VALUEIN  function is translated to a set of OROR  conditions. If the list of OROR  conditions is large and

the maximum total length of an SQL statement might be exceeded, consider using the VALUEINLARGE  function.

In some cases, it can be translated to a database SQL statement by using the EXISTS JOIN  operator.

In your model mapping, you define the L istL ist data source of the Calculated field type. This data source contains

the expression SPLIT ("a,b,c", ",") .

When a data source is called, if it has been configured as the VALUEIN ("B", List, List.Value)  expression, it

returns TRUETRUE. In this case, the VALUEIN  function is translated to the following set of conditions: 

(("B" = "a") or ("B" = "b") or ("B" = "c")) , where ("B" = "b")  equals TRUETRUE.

When a data source is called, if it has been configured as the VALUEIN ("B", List, LEFT(List.Value, 0))

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-logical-valuein.md
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Example 2

select … from Intrastat
exists join TableId from IntrastatPort
where IntrastatPort.PortId = Intrastat.Port

Example 3

Intrastat.dataAreaId IN ('DEMF', 'GBSI', 'USMF')

Additional resources

expression, it returns FALSEFALSE. In this case, the VALUEIN  function is translated to the following condition: 

("B" = "") , which doesn't equal TRUETRUE.

The upper limit for the number of characters in the text of such a condition is 32,768 characters. Therefore, you

should not create data sources that might exceed this limit at runtime. If the limit is exceeded, the application

stops running, and an exception is thrown. For example, this situation can occur if the data source is configured

as WHERE (List1, VALUEIN (List1.ID, List2, List2.ID) , and the L ist1List1  and L ist2List2  lists contain a large volume of

records.

In some cases, the VALUEIN  function is translated to a database statement by using the EXISTS JOIN  operator.

This behavior occurs when the FILTER  function is used and the following conditions are met:

The ASK FOR QUERYASK FOR QUERY option is turned off for the data source of the VALUEIN  function that refers to the list

of records. No additional conditions will be applied to this data source at runtime.

No nested expressions are configured for the data source of the VALUEIN  function that refers to the list of

records.

A list item of the VALUEIN  function refers to a field of the specified data source, not to an expression or

method of that data source.

Consider using this option instead of the WHERE  function that is described earlier in this example.

You define the following data sources in your model mapping:

The InIn data source of the Table records type. This data source refers to the Intrastat table.

The Por tPor t data source of the Table records type. This data source refers to the IntrastatPort table.

When a data source is called that has been configured as the FILTER (In, VALUEIN(In.Port, Port, Port.PortId)

expression, the following SQL statement is generated to return filtered records of the Intrastat table.

For dataAreaIddataAreaId fields, the final SQL statement is generated by the using IN  operator.

You define the following data sources in your model mapping:

The LeLe data source of the Calculated field type. This data source contains the expression 

SPLIT ("DEMF,GBSI,USMF", ",") .

The InIn data source of the Table records type. This data source refers to the Intrastat table, and the Cross-Cross-

companycompany  option is turned on for it.

When a data source is called that has been configured as the 

FILTER (In, VALUEIN (In.dataAreaId, Le, Le.Value)  expression, the final SQL statement contains the following

condition.
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List of ER functions in the mathematical category
2/18/2021 • 2 minutes to read • Edit Online

List of supported functions

F UN C T IO NF UN C T IO N DESC RIP T IO NDESC RIP T IO N

Abs This function returns the absolute value (modulus) of the
specified number as a Real value. In other words, it returns
the number without its sign.

Power This function returns a Real value that represents the result
of raising the specified positive number to the specified
power.

Round This function returns the specified number as a Real value
after it has been rounded to the specified number of decimal
places.

RoundDown This function returns the specified number as a Real value
after it has been rounded down to the specified number of
decimal places.

RoundUp This function returns the specified number as a Real value
after it has been rounded up to the specified number of
decimal places.

Additional resources

NOTENOTE

Electronic reporting (ER) mathematical functions can be used to do many common mathematical calculations.

This topic provides a summary of these functions.

Electronic Reporting overview

Formula designer in Electronic reporting
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ABS ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

ABS (number)

Arguments

Return values

Example

Additional resources

NOTENOTE

The ABS  function returns the absolute value (modulus) of the specified number as a Real value. In other words,

it returns the number without its sign.

number : Real

A numeric value that you want the modulus of.

Real

The resulting numeric value.

ABS (-1)  returns 11 .

Mathematical functions
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POWER ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

POWER (number, power)

Arguments

Return values

Example 1

Example 2

Additional resources

NOTENOTE

The POWER  function returns a Real value that represents the result of raising the specified positive number to the

specified power.

number : Real or Integer

A numeric value that must be raised to the specified power.

power : Real or Integer

A numeric value that represents the specific power.

Real

The resulting numeric value.

POWER (10, 2)  returns 100100 .

POWER (4, 0.5)  returns 22 .

Mathematical functions
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ROUND ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

ROUND (number, decimals)

Arguments

Return values

Usage notes

Example 1

Example 2

Example 3

Additional resources

The ROUND  function returns the specified number as a Real value after it has been rounded to the specified

number of decimal places.

number : Real

A numeric value that must be rounded.

decimals : Integer

A numeric value that represents the number of decimal places.

Real

The resulting numeric value.

If the value of the decimals  argument is more than 0 (zero), the specified number is rounded to that many

decimal places.

If the value of the decimals  argument is 00  (zero), the specified number is rounded to the nearest even integer.

If the value of the decimals  argument is less than 0 (zero), the specified number is rounded to the left of the

decimal point.

ROUND (1200.767, 2)  rounds to two decimal places and returns 1200.771200.77 .

ROUND (1200.767, -3)  rounds to the nearest multiple of 1,000 and returns 10001000 .

ROUND (1200.5, 0)  rounds to the nearest even integer and returns 12001200 , while ROUND (1201.5, 0)  does the

same and returns 12021202 .
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ROUNDDOWN ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

ROUNDDOWN (number, decimals)

Arguments

Return values

Usage notes

Example 1

Example 2

Additional resources

NOTENOTE

The ROUNDDOWN  function returns the specified number as a Real value after it has been rounded down to the

specified number of decimal places.

number : Real

A numeric value that must be rounded down.

decimals : Integer

A numeric value that represents the number of decimal places.

Real

The resulting numeric value.

This function behaves like ROUND, but it always rounds the specified number down (toward zero).

ROUNDDOWN (1200.767, 2)  rounds down to two decimal places and returns 1200.761200.76 .

ROUNDDOWN (1700.767, -3)  rounds down to the nearest multiple of 1,000 and returns 10001000 .

Mathematical functions
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ROUNDUP ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

ROUNDDOWN (number, decimals)

Arguments

Return values

Usage notes

Example 1

Example 2

Additional resources

NOTENOTE

The ROUNDUP  function returns the specified number as a Real value after it has been rounded up to the specified

number of decimal places.

number : Real

A numeric value that must be rounded up.

decimals : Integer

A numeric value that represents the number of decimal places.

Real

The resulting numeric value.

This function behaves like ROUND, but it always rounds the specified number up (away from zero).

ROUNDUP (1200.763, 2)  rounds up to two decimal places and returns 1200.771200.77 .

ROUNDUP (1200.767, -3)  rounds up to the nearest multiple of 1,000 and returns 20002000 .

Mathematical functions
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List of ER functions in the record category
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List of supported functions

F UN C T IO NF UN C T IO N DESC RIP T IO NDESC RIP T IO N

NullContainer This function returns a null Container (record) value that has
the same structure as the specified record list or record.

EmptyRecord This function returns a null Container (record) value that has
the same structure as the specified record list or record.

Additional resources

NOTENOTE

Electronic reporting (ER) record functions can be used to extract information from, and perform operations on,

data sources of the Container (record) data type. This topic provides a summary of these functions.
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EMPTYRECORD ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

EMPTYRECORD (list)

Arguments

Return values

Usage notes

NOTENOTE

Example

Additional resources

NOTENOTE

The EMPTYRECORD  function returns a null Container (record) value that has the same structure as the specified

record list or record.

list : Record list or Container (record)

The valid path of a data source of either the Record list or Container (record) type.

Container (record)

The resulting record value.

A null record is a record where all fields have an empty value. An empty value is 00  (zero) for numbers, an empty string for

strings, and so on.

EMPTYRECORD (SPLIT ("abc", 1))  returns a new empty record that has the same structure as the list that is

returned by the SPLIT  function. For more information, see SPLIT.

Record functions
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NULLCONTAINER ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

NULLCONTAINER (list)

Arguments

Return values

Usage notes

NOTENOTE

Example

Additional resources

NOTENOTE

The NULLCONTAINER  function returns a null Container (record) value that has the same structure as the specified

record list or record.

list : Record list or Container (record)

The valid path of a data source of either the Record list or Container (record) type.

Container (record)

The resulting record value.

This function is obsolete. Use the EMPTYRECORD  function instead. For more information, see EMPTYRECORD.

NULLCONTAINER (SPLIT ("abc", 1))  returns a new empty record that has the same structure as the list that is

returned by the SPLIT  function. For more information, see SPLIT.

Record functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-record-nullcontainer.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


List of ER functions of the text category
2/18/2021 • 2 minutes to read • Edit Online

List of supported functions

F UN C T IO NF UN C T IO N DESC RIP T IO NDESC RIP T IO N

Char This function returns a String value that presents a single
character that is referenced by the specified Unicode number.

Concatenate This function returns all the specified text strings as a String
value after they have been joined into one string.

Format This function returns the specified string a String value after
it has been formatted by substituting any occurrences of
%N%N with the Nth argument.

GetEnumValueByName This function searches for a specific Enum value in the
specified enumeration data source by using the enumeration
name that is specified as a String value. If the Enum value is
found, the function returns it.

GuidValue This function converts the specified input of the String type
to a data item of the GUID type.

JsonValue This function parses data in JavaScript Object Notation
(JSON) format that is accessed at the specified path, and it
extracts a scalar value that is based on the specified ID. It
then returns the extracted scalar value as a String value.

Left This function returns a String value that presents the
specified number of characters from the start of the specified
string.

Len This function returns an Integer value that presents the
number of characters in the specified string.

Lower This function returns the specified text string as a String
value after it has been converted to lowercase letters.

Mid This function returns a String value that presents the
specified number of characters from the specified string,
starting at the specified position.

NumberFormat This function returns a String value that presents the
specified number in the specified format and in an optionally
specified culture.

Electronic reporting (ER) text functions can be used to perform operations on data sources of the String data

type. This topic provides a summary of these functions.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-category-text.md


NumeralsToText This function returns the specified number as a String value
after it has been spelled out (that is, converted to text
strings) in the specified language.

PadLeft This function returns a String value of the specified length,
where the start of the specified string is padded with one or
more instances of the specified characters.

QrCode This function returns a Container value that presents the
Quick Response code (QR code) image for the specified
string in binary format.

Replace This function returns the specified text string as a String
value after all or part of it has been replaced with another
string.

Right This function returns a String value that presents the
specified number of characters from the end of the specified
string.

Text This function returns the specified number as a String value
after it has been converted to a text string that is formatted
according to the server locale settings of the current
application instance.

Translate This function returns a String value that contains the result
of the replacement the specified text in characters for
another provided set of characters.

Trim This function returns the specified text string as a String
value after leading and trailing spaces have been truncated,
and after multiple spaces between words have been
removed.

Upper This function returns the specified text string as a String
value after it has been converted to uppercase letters.

F UN C T IO NF UN C T IO N DESC RIP T IO NDESC RIP T IO N

Additional resources

NOTENOTE

Electronic Reporting overview

Formula designer in Electronic reporting

Electronic reporting formula language
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Syntax

CHAR (number)

Arguments

Return values

Usage notes

Example

Additional resources

NOTENOTE

The CHAR  function returns a String value that presents a single character that is referenced by the specified

Unicode number.

number : Integer

A number that corresponds to an expected single character.

String

The resulting text value.

The string that this function returns depends on the encoding that is selected in the parent FILEFILE format element.

For a list of the supported encodings, see Encoding class.

CHAR (255)  returns "ÿ""ÿ".

Text functions
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Syntax

CONCATENATE (text 1[, text 2, …, text N])

Arguments

Return values

Example

Usage notes

Additional resources

NOTENOTE

The CONCATENATE  function returns all the specified text strings as a String value after they have been joined into

one string.

text 1 : String

A reference to a data source of the String data type. This argument is required.

text N : String

A reference to a data source of the String data type. These additional arguments are optional.

String

The resulting text value.

CONCATENATE ("abc", "def")  returns "abcdef""abcdef".

The expression "abc" & "def"  also returns "abcdef""abcdef".

Text functions
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Syntax

FORMAT (string, argument 1[, argument 2, …, argument N])

Arguments

Return values

Usage notes

Example

The FORMAT  function returns the specified string as a String value after it has been formatted by substituting any

occurrences of %N%N with the Nth argument.

string : String

A reference to a data source of the String type that must be formatted. This argument is required.

argument 1 : String

The first argument, which is used to replace occurrences of %1%1 . This argument is required.

argument N : String

The Nth argument, which is used to replace occurrences of %2%2 , %3%3 , and so on. These additional arguments are

optional.

String

The resulting text value.

If an argument isn't provided for a parameter, the parameter is returned as "%N""%N" in the string. For values of the

Real type, the default string conversion is limited to two decimal places.

In the following illustration, the PaymentModelPaymentModel  data source returns a list of customer records by using the

CustomerCustomer  component. It returns the processing date value by using the ProcessingDateProcessingDate field.

In the Electronic reporting (ER) format that is designed to generate an electronic file for selected customers,

PaymentModelPaymentModel  is selected as a data source, and it controls the process flow. If a selected customer is stopped

for the date when the report is processed, an exception is thrown to notify the user. The formula that is designed

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-text-format.md
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FORMAT (CONCATENATE (@"SYS70894", ". ", @"SYS18389"), model.Customer.Name, DATETIMEFORMAT 
(model.ProcessingDate, "d"))

NOTENOTE

Additional resources

NOTENOTE

for this type of processing control can use the following resources:

Label SYS70894, which has the following text:

For the EN-US language:For the EN-US language: "Nothing to print"

For the DE language:For the DE language: "Nichts zu drucken"

Label SYS18389, which has the following text:

For the EN-US language:For the EN-US language: "Customer %1 is stopped for %2."

For the DE language:For the DE language: "Debitor '%1' wird für %2 gesperrt."

Here is the expression that can be designed.

If a report is processed for the L itware RetailL itware Retail  customer on December 17, 2015, in the EN-USEN-US  culture and the

EN-USEN-US  language, this formula returns the following text, which can be presented to the user as an exception

message:

Nothing to print. Customer Litware Retail is stopped for 12/17/2015.

If the same report is processed for the L itware RetailL itware Retail  customer on December 17, 2015, in the DEDE culture and

the DEDE language, the formula returns the following text, which uses a different date format:

Nichts zu drucken. Debitor 'Litware Retail' wird für 17.12.2015 gesperrt.

The following syntax is applied in ER formulas for labels:

For labels from resources in the Microsoft Dynamics 365 Finance app:For labels from resources in the Microsoft Dynamics 365 Finance app:  @X@X, where XX is the label ID in the

Application Object Tree (AOT)

For labels that reside in ER configurations:For labels that reside in ER configurations:  @"GER_L ABEL:X"@"GER_L ABEL:X", where XX is the label ID in the ER configuration

Text functions
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Syntax

GETENUMVALUEBYNAME (enumeration data source path, enumeration value text)

Arguments

Return values

Usage notes

Example 1

The GETENUMVALUEBYNAME  function searches for a specific Enum value in the specified enumeration data source by

using the enumeration name that is specified as a String value. If the Enum value is found, the function returns it.

Otherwise, the function returns the nullnull  enumeration value.

enumeration data source path : Enumeration

The valid path of a data source of one of the following enumeration types:

Electronic reporting (ER) model enumeration

ER format enumeration

Microsoft Dynamics 365 Finance enumeration

enumeration value text : String

A string value that represents the name of a single enumeration value.

Nullable Enum

The resulting enumeration value.

No exception is thrown if an Enum value isn't found by using the name of the enumeration value that is

specified as a String value.

In the following illustration, the Repor tDirectionRepor tDirection enumeration is introduced in a data model. Notice that labels

are defined for the enumeration values.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-text-getenumvaluebyname.md


Example 2

NOTENOTE

The following illustration shows these details:

The $Direction$Direction data source is configured in an ER report. This data source is configured based on the

Repor tDirectionRepor tDirection model enumeration.

The $IsArrivals  expression is designed to use the model enumeration–based $Direction$Direction data source as a

parameter of this function.

The value of this comparison expression is TRUETRUE.

The GETENUMVALUEBYNAME  and LISTOFFIELDS  functions let you fetch values and labels of supported enumerations

as text values. (The supported enumerations are application enumerations, data model enumerations, and

format enumerations.)

In the following illustration, the TransTypeTransType data source is introduced in a model mapping. This data source

refers to the LedgerTransTypeLedgerTransType application enumeration.

The following illustration shows the TransTypeListTransTypeList data source that is configured in a model mapping. This

data source is configured based on the TransTypeTransType application enumeration. The LISTOFFIELDS  function is used

to return all enumeration values as a list of records that contain fields. In this way, the details of every

enumeration value are exposed.

The EnumValueEnumValue field is configured for the TransTypeListTransTypeList  data source by using the 

GETENUMVALUEBYNAME(TransType, TransTypeList.Name)  expression. This field returns an enumeration value for every

record in this list.



NOTENOTE

The following illustration shows the VendTransVendTrans  data source that is configured in a model mapping. This data

source returns vendor transaction records from the VendTransVendTrans  application table. The ledger type of every

transaction is defined by the value of the TransTypeTransType field.

The TransTypeTitleTransTypeTitle field is configured for the VendTransVendTrans data source by using the 

FIRSTORNULL(WHERE(TransTypeList, TransTypeList.EnumValue = @.TransType)).Label  expression. This field returns

the label of an enumeration value of the current transaction as text, if this enumeration value is available. Otherwise, it

returns a blank string value.

The TransTypeTitleTransTypeTitle field is bound to the LedgerTypeLedgerType field of a data model that enables this information to be used in

every ER format that uses the data model as a source of data.

The following illustration shows how you can use the data source debugger to test the configured model

mapping.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/er-debug-data-sources


Additional resources

NOTENOTE

The LedgerTypeLedgerType field of a data model exposes labels of transaction types as expected.

If you plan to use this approach for a large amount of transactional data, you must consider execution

performance. For more information, see Trace the execution of ER formats to troubleshoot performance issues.

Text functions

Trace the execution of ER formats to troubleshoot performance issues

LISTOFFIELDS ER function

FIRSTORNULL ER function

WHERE ER function
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Syntax

GUIDVALUE (input)

Arguments

Return values

Usage notes

Example

Additional resources

NOTENOTE

The GUIDVALUE  function converts the specified input of the String type to a data item of the GUID type.

input : String

The valid path of a data source of the String type.

GUID

The resulting globally unique identifier (GUID) value.

To do a conversion in the opposite direction (that is, to convert specified input of the GUID data type to a data

item of the String data type), you can use the TEXT function.

You define the following data sources in your model mapping:

A myIDmyID data source of the Calculated field type that contains the expression 

GUIDVALUE ("AF5CCDAC-F728-4609-8C8B- A4B30B0C0AA0")

A UsersUsers  data source of the Table records type that refers to the UserInfo table

You can then use an expression such as FILTER (Users, Users.objectId = myID)  to filter the UserInfo table by the

objectIdobjectId field of the GUID data type.

Text functions
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Syntax

JSONVALUE (input, path)

Arguments

Return values

Example

Additional resources

NOTENOTE

The JSONVALUE  function parses data in JavaScript Object Notation (JSON) format that is accessed at the

specified path, and it extracts a scalar value that has the specified ID. It then returns the extracted scalar value as

a String value.

input : String

The valid path of a data source of the String type that contains JSON data.

path : String

The identifier of a scalar value of JSON data.

String

The resulting text value.

The JsonFieldJsonField data source contains the following data in JSON format: {"BuildNumber":"7.3 .1234.1",{"BuildNumber":"7.3 .1234.1",

"KeyThumbprint":"7366E"}"KeyThumbprint":"7366E"} . In this case, the expression JSONVALUE (JsonField, "BuildNumber")  returns the

following value of the String data type: "7.3 .1234.1""7.3 .1234.1".

Text functions
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Syntax

LEFT (text, number)

Arguments

Return values

Example

Additional resources

NOTENOTE

The LEFT  function returns a String value that presents the specified number of characters from the start of the

specified string.

text : String

A String value that represents the original text.

number : Integer

The number of characters that must be returned from the start of the original text.

String

The resulting text value.

LEFT ("Sample", 3)  returns "Sam""Sam".

Text functions
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Syntax

LEN (text)

Arguments

Return values

Example

Additional resources

NOTENOTE

The LEN  function returns the number of characters in the specified string as an Integer value.

text : String

A String value that specifies the text.

Integer

The resulting numeric value.

LEN ("Sample")  returns 66 .

Text functions
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Syntax

LOWER (text)

Arguments

Return values

Example

Additional resources

NOTENOTE

The LOWER  function returns the specified text string as a String value after it has been converted to lowercase

letters.

text : String

A String value that specifies the text.

String

The resulting text value.

LOWER ("Sample")  returns "sample""sample".

Text functions
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Syntax

MID (text, starting position, number of characters)

Arguments

Return values

Usage notes

Example

Additional resources

The MID  function returns a String value that presents the specified number of characters from the specified

string, starting at the specified position.

text : String

A String value that specifies the text to return characters from.

starting position : Integer

An Integer value that specifies the position of the first character that must be returned from the specified text.

number of characters : Integer

An Integer value that specifies the number of characters that must be returned, starting at the specified starting

position.

String

The resulting text value.

If the value of the starting position  argument is less than 0 (zero), the characters that are returned are counted

from the first position in the specified string.

If the value of the starting position  argument exceeds length of the specified string, an empty string is

returned.

MID ("Sample", 2, 3)  returns "amp""amp".

Text functions
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NOTENOTE
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Syntax 1

NUMBERFORMAT (number, format)

Syntax 2

NUMBERFORMAT (number, format, culture)

Arguments

Return values

Usage notes

Example 1

Example 2

Additional resources

The NUMBERFORMAT  function returns a String value that presents the specified number in the specified format and

in an optionally specified culture. For information about the supported formats, see standard and custom.

number : Integer or Real

A numeric value that specifies the number that must be formatted.

format  : String

A String value that represents the format.

culture : String

A String value that represents the culture to use for formatting.

String

The resulting text value.

If the culture isn't defined as an argument of the called function, the context that this function is run in

determines the culture that is used to format numbers.

For the EN-USEN-US  culture, NUMBERFORMAT (0.45, "p")  returns "45.00 %""45.00 %", and NUMBERFORMAT (10.45, "#")  returns

"10""10".

NUMBERFORMAT (10/3, "F2", "de")  returns 3,333,33 , whereas NUMBERFORMAT (10/3, "F2", "en-us")  returns 3.333.33 .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-text-numberformat.md
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NOTENOTE

Text functions
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Syntax

NUMERALSTOTEXT (number, language, currency, print currency name flag, decimal points)

Arguments

Return values

Usage notes

NOTENOTE

The NUMERALSTOTEXT  function returns the specified number as a String value after it has been spelled out (that is,

converted to text strings) in the specified language.

number : Integer or Real

A numeric value that specifies the number that must be spelled out.

language : String

A String value that represents the language code.

currency : String

A String value that represents the currency code.

print currency name flag : Boolean

A Boolean value that indicates whether a currency name must be added to the spelled-out text.

decimal points : Integer

An Integer value that indicates the number of decimal places that the spelled-out text should have.

String

The resulting text value.

The language code is optional. If it's defined as an empty string, the language code for the running context is

used. The default language code is EN-USEN-US . The language code for the running context is defined in a FolderFolder  or

FileFile element of the Electronic reporting (ER) format that is running.

The currency code is optional. If it's defined as an empty string, the company currency for the running context is

used.

The print currency name flag  and decimal points  arguments are analyzed only for the following language codes:

CSCS, ETET, HUHU, LTLT, LVLV , PLPL , and RURU. Additionally, the print currency name flag  argument is analyzed only for companies

where the country's or region's context supports declension of currency names.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-text-numeralstotext.md


Example 1

Example 2

Example 3

Additional resources

NOTENOTE

NUMERALSTOTEXT (1234.56, "EN-US", "", false, 2)  returns "One Thousand Two Hundred Thir ty Four and"One Thousand Two Hundred Thir ty Four and

56"56".

NUMERALSTOTEXT (120, "PL", "", false, 0)  returns "Sto dwadzie"Sto dwadzieścia"cia".

NUMERALSTOTEXT (120.21, "RU", "EUR", true, 2)  returns ""Сто  двадцать  евро 21  21 евроцент"".

Text functions
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Syntax

PADLEFT (text, length, padding chars)

Arguments

Return values

Example

Additional resources

NOTENOTE

The PADLEFT  function returns a String value of the specified length, where the start of the specified string is

padded with the specified characters.

text : String

A String value that represents the original text.

length : Integer

An Integer value that represents the final number of characters in the padded string.

padding chars : String

The characters to use for padding.

String

The resulting text value.

PADLEFT ("1234", 10, "  ")  returns the text string "      1234""      1234".

Text functions
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Syntax

QRCODE (text)

Arguments

Return values

Example

QRCODE (model.ListOfShelfLabels.LabelText)`

Additional resources

NOTENOTE

The QRCODE  function returns a Container value that presents the Quick Response code (QR code) image for the

specified string in binary format.

text : String

A String value that represents the original text.

Container

The resulting binary stream.

You can configure an Electronic reporting (ER) format to generate an outbound document in Microsoft Office

format (Excel workbooks or Word documents) by using a predefined template. This template may contain a

PicturePicture object (Excel workbook) or a Picture Content ControlPicture Content Control  (Word document) as a placeholder for a QR

code image. You need to add to the configured ER format a CellCell  element that will be used to fill this placeholder

in. To specify what information will be stored in a QR code, you need to define a binding for this CellCell  element.

For example, you can configure such binding as containing the following expression:

When you run the configured ER format, the text value of the LabelTextLabelText field of the model.L istOfShelfLabelsmodel.L istOfShelfLabels

data source will be used to generate a QR code image. This image will replace a QR code image placeholder in

the document template using to generate an outbound document. When this image of the generated document

is scanned, it returns the text that was taken from the LabelTextLabelText field of the model.L istOfShelfLabelsmodel.L istOfShelfLabels  data

source. For more information, see Embed images and shapes in documents that you generate by using ER.

Text functions
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https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-text-qrcode.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


REPLACE ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

REPLACE (text, pattern, replacement, regular expression flag)

Arguments

Return values

Usage notes

Example 1

The REPLACE  function returns the specified text string as a String value after all or part of it has been replaced

with another string.

text : String

The valid path of a data source of the String type.

pattern : String

If the regular expression flag  argument is FALSEFALSE, this argument contains the text that must be replaced.

If the regular expression flag  argument is TRUETRUE, this argument contains a regular expression that defines both

a search pattern and the replacement text.

replacement : String

If the regular expression flag  argument is FALSEFALSE, this argument contains the text to use as a replacement.

If the regular expression flag  argument is TRUETRUE, this argument isn't used.

regular expression flag : Boolean

A Boolean value that indicates whether a regular expression is used to do the replacement.

String

The resulting text value.

If the regular expression flag  argument is TRUETRUE, this function returns the specified string after it has been

changed by applying the regular expression that is specified by the pattern  argument. The regular expression

is used to find the characters that must be replaced.

If the regular expression flag  argument is FALSEFALSE, this function returns the specified string after the set of

characters that are defined in the pattern  argument have been replaced by characters of the replacement

argument.

REPLACE ("+1 923 456 4971", "[^0-9]", "", true)  applies a regular expression that removes all non-numeric

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-text-replace.md


Example 2

Additional resources

NOTENOTE

symbols, and it returns "19234564971""19234564971".

REPLACE ("abcdef", "cd", "GH", false)  replaces the pattern "cd""cd" with the string "GH""GH" and returns "abGHef""abGHef".

Text functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


RIGHT ER function
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Syntax

RIGHT (text, number)

Arguments

Return values

Example

Additional resources

NOTENOTE

The RIGHT  function returns a String value that presents the specified number of characters from the end of the

specified string.

text : String

A String value that represents the original text.

number : Integer

The number of characters that must be returned from the end of the original text.

String

The resulting text value.

RIGHT ("Sample", 3)  returns "ple""ple".

Text functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-text-right.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


TEXT ER function
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Syntax

TEXT (number)

Arguments

Return values

Usage notes

Example

Additional resources

NOTENOTE

The TEXT  function returns the specified number as a String value after it has been converted to a text string that

is formatted according to the server locale settings of the current application instance.

number : Integer or Real

A number that must be converted to a text string.

String

The resulting text value.

For values of the Real type, the string conversion is limited to two decimal places.

If the server locale of the Microsoft Dynamics 365 Finance instance is defined as EN-USEN-US , TEXT (NOW ())  returns

the current Finance session date, December 17, 2015, as the text string "12/17/2015 07:59:23 AM""12/17/2015 07:59:23 AM". 

TEXT (1/3)  returns "0.33""0.33".

Text functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-text-text.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


TRANSLATE ER function
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Syntax

TRANSLATE (text , pattern, replacement)

Arguments

Return values

Usage notes

Example 1

Example 2

The TRANSLATE  function returns a String value that contains the result of the character replacement of specified

text in characters of another provided set.

text : String

The valid path of a data source of the String type.

pattern : String

The text that must be replaced.

replacement : String

The text to use as a replacement.

String

The resulting text value.

The TRANSLATE  function replaces one character at a time. The function replaces the first character of the text

argument with the first character of the pattern  argument and then the second character and follows the same

flow until finished. When a character from the text  and pattern  arguments match, it is replaced by a

character from the replacement  argument that is located in the same position as the character from the 

pattern  argument. If a character appears multiple times in the pattern  argument, the replacement  argument

mapping that corresponds to the first occurrence of this character is used.

TRANSLATE ("abcdef", "cd", "GH")  replaces the "c""c" character of the specified “abcdef ”“abcdef ”  text with the "G""G"

character of the replacement  text due to the following:

The "c""c" character is presented in the pattern  text in the first position.

The first position of the replacement  text contains the "G""G" character.

TRANSLATE ("abcdef", "ccd", "GH")  returns "abGdef""abGdef".

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-text-translate.md


Example 3

Additional resources

NOTENOTE

TRANSLATE ("abccba", "abc", "123")  returns "123321""123321".

Text functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


TRIM ER function
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Syntax

TRIM (text )

Arguments

Return values

Example

Additional resources

NOTENOTE

The TRIM  function returns the specified text string as a String value after leading and trailing spaces have been

truncated, and after multiple spaces between words have been removed.

text : String

The valid path of a data source of the String type.

String

The resulting text value.

TRIM ("      Sample      text      ")  returns "Sample text""Sample text".

Text functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-text-trim.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


UPPER ER function
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Syntax

UPPER (text )

Arguments

Return values

Example

Additional resources

NOTENOTE

The UPPER  function returns the specified text string as a String value after it has been converted to uppercase

letters.

text : String

The valid path of a data source of the String type.

String

The resulting text value.

UPPER ("Sample")  returns "SAMPLE""SAMPLE".

Text functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-text-upper.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


List of ER functions in the data collection category
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List of supported functions

F UN C T IO NF UN C T IO N DESC RIP T IO NDESC RIP T IO N

CollectedList This function returns a Record list value that contains the list
of values that were returned by the Collected data keyCollected data key
valuevalue property of format elements and collected when the
format elements were used to generate an outbound
document during the format run, and that satisfies the
specified conditions. Each condition consists of a key range
and a key value.

CountIF This function returns an Integer value that represents the
number of format elements that was collected when the
format elements were used to generate an outbound
document during the format run, and that satisfies the
specified condition. The condition consists of a key range
and a key value.

CountIFs This function returns an Integer value that represents the
number of format elements that was collected when the
format elements were used to generate an outbound
document during the format run, and that satisfies the
specified conditions. Each condition consists of a key range
and a key value.

FormatElementName This function returns a String value that represents the name
of the current ER format's element.

SumIF This function returns a Real value that represents the sum of
values that were returned by bindings of format elements
and collected when the format elements were used to
generate an outbound document during the format run, and
that satisfies the specified condition. The condition consists
of a key range and a key value.

SumIFs This function returns a Real value that represents the sum of
values that were returned by bindings of format elements
and collected when the format elements were used to
generate an outbound document during the format run, and
that satisfies the specified conditions. Each condition consists
of a key range and a key value.

Additional resources

Electronic reporting (ER) data collection functions are used to do counting and summing in an ER format that is

being run, based on data of the output that has already been generated in TextText or XmlXml format. This approach is

used to help improve performance of an ER format that is run, to enter values of running totals in generated

documents, and for other purposes. This topic provides a summary of these functions.

Electronic Reporting overview

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-category-data-collection.md


NOTENOTE

Formula designer in Electronic reporting

Electronic reporting formula language

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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COLLECTEDLIST ER function
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Syntax

COLLECTEDLIST (condition 1 range, condition 1 value[, condition 2 range, condition 2 value, …, condition N 
range, condition N value])

Arguments

Return values

Usage notes

The COLLECTEDLIST  function a Record list value that contains the list of values that were returned by the

Collected data key valueCollected data key value property of format elements and collected when the format elements were used to

generate outbound documents during the format run, and that satisfies the specified conditions. Each condition

consists of a key range and a key value.

condition 1 range : String

A value that is returned by the expression that has been configured in the Collected data key nameCollected data key name property

of an Electronic reporting (ER) format component. This argument is mandatory.

condition 1 value : String

A value that is returned by the expression that has been configured in the Collected data key valueCollected data key value property

of an ER format component. This argument is mandatory.

condition N range : String

A value that is returned by the expression that has been configured in the Collected data key nameCollected data key name property

of an ER format component. These additional arguments are optional.

condition N value : String

A value that is returned by the expression that has been configured in the Collected data key valueCollected data key value property

of an ER format component. These additional arguments are optional.

Record list

The resulting list of records.

The Collected data key nameCollected data key name and Collected data key valueCollected data key value properties can be configured for either the

SequenceSequence component or the XML ElementXML Element component of an ER format that resides under the Common\FileCommon\File

component where the Collect output detailsCollect output details  option is turned on.

This function returns an empty list when the Collect output detailsCollect output details  option of the current Common\FileCommon\File

component is turned off.

In condition range  arguments, the wildcard character "*""*" can be used to represent any multiple characters.

In condition value  arguments, the wildcard character "*""*" can be used to represent any multiple characters.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-datacollection-collectedlist.md


Example

Additional resources

NOTENOTE

For more information about how to use this function, see the ER Use data of format output for counting and

summing task guide, which is part of the Acquire/Develop IT ser vice/solution componentsAcquire/Develop IT ser vice/solution components  business

process.

Data collection functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


COUNTIF ER function
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Syntax

COUNTIF (condition range, condition value)

Arguments

Return values

Usage notes

Example

Additional resources

The COUNTIF  function returns an Integer value that represents the number of format elements that was

collected when the format elements were used to generate an outbound document during the format run, and

that satisfies the specified condition. The condition consists of a key range and a key value.

condition range : String

A value that is returned by the expression that has been configured in the Collected data key nameCollected data key name property

of an Electronic reporting (ER) format component.

condition value : String

A value that is returned by the expression that has been configured in the Collected data key valueCollected data key value property

of an ER format component.

Integer

The resulting numeric value.

The Collected data key nameCollected data key name and Collected data key valueCollected data key value properties can be configured for either the

SequenceSequence component or the XML ElementXML Element component of an ER format that resides under the Common\FileCommon\File

component where the Collect output detailsCollect output details  option is turned on.

This function returns a 00  (zero) value when the Collect output detailsCollect output details  option of the current Common\FileCommon\File

component is turned off.

In the condition range  argument, the wildcard character "*""*" can be used to represent any multiple characters.

In the condition value  argument, the wildcard character "*""*" can be used to represent any multiple characters.

For more information about how to use this function, see the ER Use data of format output for counting and

summing task guide, which is part of the Acquire/Develop IT ser vice/solution componentsAcquire/Develop IT ser vice/solution components  business

process.

Data collection functions

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-datacollection-countif.md
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Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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COUNTIFS ER function
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Syntax

COUNTIFS (condition 1 range, condition 1 value[, condition 2 range, condition 2 value, …, condition N range, 
condition N value])

Arguments

Return values

Usage notes

The COUNTIFS  function returns an Integer value that represents the number of format elements that was

collected when the format elements were used to generate an outbound document during the format run, and

that satisfies the specified conditions. Each condition consists of a key range and a key value.

condition 1 range : String

A value that is returned by the expression that has been configured in the Collected data key nameCollected data key name property

of an Electronic reporting (ER) format component. This argument is mandatory.

condition 1 value : String

A value that is returned by the expression that has been configured in the Collected data key valueCollected data key value property

of an ER format component. This argument is mandatory.

condition N range : String

A value that is returned by the expression that has been configured in the Collected data key nameCollected data key name property

of an ER format component. These additional arguments are optional.

condition N value : String

A value that is returned by the expression that has been configured in the Collected data key valueCollected data key value property

of an ER format component. These additional arguments are optional.

Integer

The resulting numeric value.

The Collected data key nameCollected data key name and Collected data key valueCollected data key value properties can be configured for either the

SequenceSequence component or the XML ElementXML Element component of an ER format that resides under the Common\FileCommon\File

component where the Collect output detailsCollect output details  option is turned on.

This function returns a 00  (zero) value when the Collect output detailsCollect output details  option of the current Common\FileCommon\File

component is turned off.

In condition range  arguments, the wildcard character "*""*" can be used to represent any multiple characters.

In condition value  arguments, the wildcard character "*""*" can be used to represent any multiple characters.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-datacollection-countifs.md


Example

Additional resources

NOTENOTE

For more information about how to use this function, see the ER Use data of format output for counting and

summing task guide, which is part of the Acquire/Develop IT ser vice/solution componentsAcquire/Develop IT ser vice/solution components  business

process.

Data collection functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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FORMATELEMENTNAME ER function
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Syntax

FORMATELEMENTNAME ()

Return values

Usage notes

Example

Additional resources

NOTENOTE

The FORMATELEMENTNAME  function returns a String value that represents the name of the current Electronic

reporting (ER) format's element.

String

The resulting text value.

This function can be called in ER expressions that were configured for the Collected data key nameCollected data key name and

Collected data key valueCollected data key value properties of an ER format component from the TextText group that resides under the

Common\FileCommon\File component where the Collect output detailsCollect output details  option is turned on.

For more information about how to use this function, see the ER Use data of format output for counting and

summing task guide, which is part of the Acquire/Develop IT ser vice/solution componentsAcquire/Develop IT ser vice/solution components  business

process.

Data collection functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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SUMIF ER function
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Syntax

SUMIF (key name for summing, condition range, condition value)

Arguments

Return values

Usage notes

Example

Additional resources

The SUMIF  function returns a Real value that represents the sum of values that were returned by bindings of

format elements and collected when the format elements were used to generate an outbound document during

the format run, and that satisfies the specified condition. The condition consists of a key range and a key value.

key name for summing : String

A value that is returned by the expression that has been configured in the Collected data key nameCollected data key name property

of the Electronic reporting (ER) format component for which the value of the binding must be used for summing

purposes.

The Collected data key valueCollected data key value property can be configured for either a SequenceSequence component or an XMLXML

ElementElement component of an ER format that resides under the Common\FileCommon\File component where the CollectCollect

output detailsoutput details  option is turned on.

Real

The resulting numeric value.

This function returns a 00  (zero) value when the Collect output detailsCollect output details  option of the current Common\FileCommon\File

component is turned off.

In the condition range  argument, the wildcard character "*""*" can be used to represent any multiple characters.

In the condition value  argument, the wildcard character "*""*" can be used to represent any multiple characters.

For more information about how to use this function, see the ER Use data of format output for counting and

summing task guide, which is part of the Acquire/Develop IT ser vice/solution componentsAcquire/Develop IT ser vice/solution components  business

process.

For more information and examples about using this function, see Defer the execution of sequence elements in

ER formats and Defer the execution of XML elements in ER formats.

Data collection functions

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-datacollection-sumif.md
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SUMIFS ER function
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Syntax

SUMIFS (key name for summing, condition 1 range, condition 1 value[, condition 2 range, condition 2 value, 
…, condition N range, condition N value])

Arguments

The SUMIFS  function returns a Real value that represents the sum of values that were returned by bindings of

format elements and collected when the format elements were used to generate an outbound document during

the format run, and that satisfies the specified conditions. Each condition consists of a key range and a key value.

key name for summing : String

A value that is returned by the expression that has been configured in the Collected data key nameCollected data key name property

of the Electronic reporting (ER) format component for which the value of the binding must be used for summing

purposes.

The Collected data key nameCollected data key name property can be configured for either a NumericNumeric component or a Str ingStr ing

component of an ER format that resides under the Common\FileCommon\File component where the Collect outputCollect output

detailsdetails  option is turned on.

condition 1 range : String

A value that is returned by the expression that has been configured in the Collected data key nameCollected data key name property

of an ER format component. This argument is mandatory.

The Collected data key nameCollected data key name property can be configured for either a SequenceSequence component or an XMLXML

ElementElement component of an ER format that resides under the Common\FileCommon\File component where the CollectCollect

output detailsoutput details  option is turned on.

condition 1 value : String

A value that is returned by the expression that has been configured in the Collected data key valueCollected data key value property

of an ER format component. This argument is mandatory.

The Collected data key valueCollected data key value property can be configured for either a SequenceSequence component or an XMLXML

ElementElement component of an ER format that resides under the Common\FileCommon\File component where the CollectCollect

output detailsoutput details  option is turned on.

condition N range : String

A value that is returned by the expression that has been configured in the Collected data key nameCollected data key name property

of an ER format component. These additional arguments are optional.

The Collected data key nameCollected data key name property can be configured for either a SequenceSequence component or an XMLXML

ElementElement component of an ER format that resides under the Common\FileCommon\File component where the CollectCollect

output detailsoutput details  option is turned on.

condition N value : String

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-datacollection-sumifs.md


Return values

Usage notes

Example

Additional resources

NOTENOTE

A value that is returned by the expression that has been configured in the Collected data key valueCollected data key value property

of an ER format component. These additional arguments are optional.

The Collected data key valueCollected data key value property can be configured for either a SequenceSequence component or an XMLXML

ElementElement component of an ER format that resides under the Common\FileCommon\File component where the CollectCollect

output detailsoutput details  option is turned on.

Real

The resulting numeric value.

This function returns a 00  (zero) value when the Collect output detailsCollect output details  option of the current Common\FileCommon\File

component is turned off.

In the condition range  arguments, the wildcard character "*""*" can be used to represent any multiple characters.

In the condition value  arguments, the wildcard character "*""*" can be used to represent any multiple characters.

For more information about how to use this function, see the ER Use data of format output for counting and

summing task guide, which is part of the Acquire/Develop IT ser vice/solution componentsAcquire/Develop IT ser vice/solution components  business

process.

Data collection functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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List of supported functions
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CH_Bank_Mod_10 This function returns a String value that represents a creditor
reference as an MOD10 expression, based on the digits of
the specified invoice number.

CN_GBT_AdditionalDimensionID This function returns a String value that represents a single
financial dimension ID that is taken from the specified string.
The specified string presents all dimensions as a comma-
separated list of IDs.

ConvertCurrency This function returns a Real value that represents the result
of converting the specified monetary amount from the
specified source currency to the specified target currency by
using the settings of the specified company on the specified
date.

CurCredRef This function returns a String value that represents a creditor
reference, based on the digits of the specified invoice
number.

FA_Balance This function returns a Container (record) value that consists
of data for the fixed asset balance for the specified fixed
asset item, value model code, reporting year, and reporting
date.

FA_Sum This function returns a Container (record) value that consists
of data for the fixed asset amounts for the specified fixed
asset item, value model code, and period of dates.

GetCurrentCompany This function returns a String value that represents the code
for the legal entity (company) that a user is currently signed
in to.

ISOCredRef This function returns a String value that represents an
International Organization for Standardization (ISO) creditor
reference, based on the digits and alphabetic symbols of the
specified invoice number.

Electronic reporting (ER) domain-specific functions can be used to perform calculations and data access

requests that are specific to the implementation of Microsoft Dynamics 365 Finance. This topic provides a

summary of these functions.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-category-other.md


IsValidCharacterISO7064 This function returns a Boolean value of TRUETRUE if the
specified string represents a valid international bank account
number (IBAN). Otherwise, it returns a Boolean value of
FALSEFALSE.

Mod_97 This function returns a String value that represents a creditor
reference as a MOD97 expression, based on the digits of the
specified invoice number.

NumSeqValue This function returns a String value that represents the new
generated value of a number sequence, based on the
specified number sequence, scope, and scope ID. The scope
ID equals the company code that is supplied by the context
that the ER format is run under.

RoundAmount This function returns a Real value that represents the result
of rounding the specified amount to the specified number of
decimal places according to the specified rounding rule.

TableName2ID This function returns a numeric representation of the table
ID for the specified table name as an Integer value.

F UN C T IO NF UN C T IO N DESC RIP T IO NDESC RIP T IO N

Additional resources

NOTENOTE

Electronic Reporting overview

Formula designer in Electronic reporting

Electronic reporting formula language
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CH_BANK_MOD_10 ER function
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Syntax

CH_BANK_MOD_10 (invoice number digits)

Arguments

Return values

Example

Additional resources

NOTENOTE

The CH_BANK_MOD_10  function returns a String value that represents a creditor reference as an MOD10

expression, based on the digits of the specified invoice number.

invoice number digits : String

A text value that represents the digits of an invoice number.

String

The resulting text value.

CH_BANK_MOD_10 ("VEND-200002")  returns 33 .

Other (business domain–specific) functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-other-chbankmode10.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


CN_GBT_ADDITIONALDIMENSIONID ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

CN_GBT_ADDITIONALDIMENSIONID (text, number)

Arguments

Return values

Example

Additional resources

NOTENOTE

The CN_GBT_ADDITIONALDIMENSIONID  function returns a String value that represents a single financial dimension ID

that is taken from the specified string. The specified string presents all dimensions as a comma-separated list of

IDs.

text : String

A String value that presents all dimensions as a comma-separated list of IDs.

number : Integer

An Integer value that defines the sequence code of the requested dimension in the specified string.

String

The resulting text value.

CN_GBT_AdditionalDimensionID ("AA,BB,CC,DD,EE,FF,GG,HH", 3)  returns "CC""CC".

Other (business domain–specific) functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-other-cngbtadditionaldimensionid.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


CONVERTCURRENCY ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

CONVERTCURRENCY (amount, source currency, target currency, date, company)

Arguments

Return values

Example

Additional resources

The CONVERTCURRENCY  function returns a Real value that represents the result of converting the specified

monetary amount from the specified source currency to the specified target currency by using the settings of

the specified company on the specified date.

amount : Integer or Real

A numeric value that represents the monetary amount that must be converted.

source currency : String

The code of the source currency.

target currency : String

The code of the target currency.

date : Date

A Date value that represents the date that is used to determine the exchange rate for the conversion.

company : String

A String value that represents the code of a company that supplies the settings that are used for the conversion.

Real

The resulting numeric value.

CONVERTCURRENCY (1, "EUR", "USD", TODAY(), "DEMF")  returns the equivalent of one euro in US dollars on the

current session date, based on settings for the DEMFDEMF company.

Other (business domain–specific) functions

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-other-convertcurrency.md


NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


CURCREDREF ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

CURCREDREF (invoice number digits)

Arguments

Return values

Example

Additional resources

NOTENOTE

The CURCREDREF  function returns a String value that represents a creditor reference, based on the digits of the

specified invoice number.

invoice number digits : String

A text value that represents the digits of an invoice number.

String

The resulting text value.

CURCredRef ("VEND-200002")  returns "2200002""2200002".

Other (business domain–specific) functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-other-curcredref.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


FA_BALANCE ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

FA_BALANCE (fixed asset code, value model code, reporting year, reporting date)

Arguments

Return values

Example

Additional resources

NOTENOTE

The FA_BALANCE  function returns a Container (record) value that consists of data for the fixed asset balance for

the specified fixed asset item, value model code, reporting year, and reporting date.

fixed asset code : String

A String value that represents the code of a fixed asset item that the balance is calculated for.

value model code : String

A String value that represents the code of a value model that the balance is calculated for.

reporting year : Enumeration value

An enumeration value of the AssetYearAssetYear  application enumeration that defines a period for the balance

calculation.

reporting date : Date

A Date value that defines a date for the balance calculation.

Container (record)

The resulting record value.

FA_ BALANCE ("COMP-000001", "Current", AxEnumAssetYear.ThisYear, SESSIONTODAY ())  returns the data container

of balances for fixed asset COMP-000001COMP-000001  that has been prepared for the CurrentCurrent value model on the current

application session date.

Other (business domain–specific) functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-other-fabalance.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


FA_SUM ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

FA_SUM (fixed asset code, value model code, start date, end date)

Arguments

Return values

Example

Additional resources

NOTENOTE

The FA_SUM  function returns a Container (record) value that consists of data for the fixed asset amounts for the

specified fixed asset item, value model code, and period of dates.

fixed asset code : String

A String value that represents the code of a fixed asset item that the balance is calculated for.

value model code : String

A String value that represents the code of a value model that the balance is calculated for.

start date : Date

A Date value that represents the start date of a period that the fixed asset amounts are calculated for.

end date : Date

A Date value that represents the end date of a period that the fixed asset amounts are calculated for.

Container (record)

The resulting record value.

FA_SUM ("COMP-000001", "Current", Date1, Date2)  returns the data container for fixed asset COMP-000001COMP-000001  that

has been prepared for the CurrentCurrent value model and for a period from Date1Date1  to Date2Date2 .

Other (business domain–specific) functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-other-fasum.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


GETCURRENTCOMPANY ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

GETCURRENTCOMPANY ()

Return values

Example

Additional resources

NOTENOTE

The GETCURRENTCOMPANY  function returns a String value that represents the code for the legal entity (company)

that a user is currently signed in to.

String

The resulting text value.

GETCURRENTCOMPANY ()  returns USMFUSMF for a user who is signed in to the Contoso Enter tainment System USAContoso Enter tainment System USA

company.

Other (business domain–specific) functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-other-getcurrentcompany.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


ISOCREDREF ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

ISOCREDREF (invoice number digits)

Arguments

Return values

Usage notes

NOTENOTE

Example

Additional resources

NOTENOTE

The ISOCREDREF  function returns a String value that represents an International Organization for Standardization

(ISO) creditor reference, based on the digits and alphabetic symbols of the specified invoice number.

invoice number digits : String

A text value that represents the digits of an invoice number.

String

The resulting text value.

To eliminate symbols from alphabets that are't ISO-compliant, the invoice number digits  argument must be

translated before it's passed to this function.

ISOCredRef ("VEND-200002")  returns "RF23VEND-200002""RF23VEND-200002".

Other (business domain–specific) functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-other-isocredref.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


ISVALIDCHARACTERISO7064 ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

ISVALIDCHARACTERISO7064 (text)

Arguments

Return values

Example

Additional resources

NOTENOTE

The ISVALIDCHARACTERISO7064  function returns a Boolean value of TRUETRUE if the specified string represents a valid

international bank account number (IBAN). Otherwise, it returns a Boolean value of FALSEFALSE.

text : String

A text value that represents an IBAN.

String

The resulting text value.

ISVALIDCHARACTERISO7064 ("AT61 1904 3002 3457 3201")  returns TRUETRUE.

ISVALIDCHARACTERISO7064 ("AT61")  returns FALSEFALSE.

Other (business domain–specific) functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-other-isvalidchariso7064.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


MOD_97 ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

MOD_97 (invoice number digits)

Arguments

Return values

Example

Additional resources

NOTENOTE

The MOD_97  function returns a String value that represents a creditor reference as a MOD97 expression, based

on the digits of the specified invoice number.

invoice number digits : String

A text value that represents the digits of an invoice number.

String

The resulting text value.

MOD_97 ("VEND-200002")  returns "20000285""20000285".

Other (business domain–specific) functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-other-mod97.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


NUMSEQVALUE ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax 1

NUMSEQVALUE (number sequence code)

Syntax 2

NUMSEQVALUE (number sequence record ID)

Syntax 3

NUMSEQVALUE (number sequence code, scope type, scope ID)

Arguments

Return values

Usage notes

The NUMSEQVALUE  function returns a String value that represents the new generated value of a number sequence,

based on the specified number sequence, scope, and scope ID. The scope ID equals the company code that is

supplied by the context that the Electronic reporting (ER) format is run under.

number sequence code : String

A text value that represents the code of the number sequence that a new value is required in.

number sequence record ID : Int64

An Int64 value that represents the record ID of a record in the NumberSequenceTable table that contains the

definition of the number sequence that a new value is required in.

scope type : Enum value

An enumeration value of the ERExpressionNumberSequenceScopeTypeERExpressionNumberSequenceScopeType enumeration that defines the scope

of the number sequence that a new value is required in. The available scope types are SharedShared, Legal entityLegal entity ,

and CompanyCompany .

scope ID : String

A String value that identifies the scope, based on the specified scope type.

String

The resulting text value.

For the SharedShared scope type, specify an empty string as the scope ID.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-other-numseqvalue.md


Example 1

Example 2

Example 3

Additional resources

NOTENOTE

For the CompanyCompany  and Legal entityLegal entity  scope types, specify the company code as the scope ID. If you specify an

empty string as the scope ID for these scope types, the current company code is used.

When syntax 1 is used, the number sequence is requested for the CompanyCompany  scope type, and the company code

is supplied by the context that the ER format is run under.

In your ER format, you define the AskNumSeqAskNumSeq data source of the User input parameter type. This data source

refers to the Descr iptionDescr iption extended data type (EDT). Next, you define the NumSeqNumSeq data source of the Calculated

field type. This data source contains the expression NUMSEQVALUE (AskNumSeq) . When the NumSeqNumSeq data source is

called, it returns the new generated value of the number sequence that was specified at runtime by entering its

code in the dialog box. The number sequence is requested for the CompanyCompany  scope type. The company code is

supplied by the context that the ER format is run under.

The following data sources are defined in your model mapping:

The LedgerParmsLedgerParms data source of the Table type. This data source refers to the LedgerParameters table.

The NumSeqNumSeq data source of the Calculated field type. This data source contains the expression 

NUMSEQVALUE ( LedgerParameters.'numRefJournalNum()'.NumberSequenceId) .

When the NumSeqNumSeq data source is called, it returns the new generated value of the number sequence that has

been configured in the General ledger parameters for the company that supplies the context that the ER format

is run under. This number sequence uniquely identifies journals and acts as a batch number that links the

transactions together.

The following data sources are defined in your model mapping:

The enumScopeenumScope data source of the Microsoft Dynamics 365 Finance enumeration type. This data source

refers to the ERExpressionNumberSequenceScopeTypeERExpressionNumberSequenceScopeType enumeration.

The NumSeqNumSeq data source of the Calculated field type. This data source contains the expression 

NUMSEQVALUE ("Gene_1", enumScope.Company, "") .

When the NumSeqNumSeq data source is called, it returns the new generated value of the Gene_1Gene_1  number sequence

that has been configured for the company that supplies the context that the ER format is run under.

Other (business domain–specific) functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


ROUNDAMOUNT ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

ROUNDAMOUNT (number, decimals, round rule)

Arguments

Return values

Usage notes

The ROUNDAMOUNT  function returns a Real value as the result of the rounding of the specified number to the

nearest multiple of another number according to the specified rounding rule.

number : Int or Real

A numeric value that must be rounded.

decimals : Int or Real

The number that the value of the number  parameter must be rounded to a multiple of.

round rule : Enum value

An enumeration value of the RoundOffTypeRoundOffType enumeration that defines the rounding rule. This enumeration

offers the following values:

Normal (Ordinary)

Downward (RoundDown)

Rounding-up (RoundUp)

Real

The resulting numeric value is a multiple of the value specified by the decimals  parameter and is closest to the

value specified by the number  parameter.

When the number  parameter is zero, this function always returns zero.

When the decimals  parameter is zero, this function rounds to the default round-off value. When the 

round rule  parameter is set to RoundOffType.Ordinar yRoundOffType.Ordinar y , the default round-off value is 0 .010.01 . Otherwise, the

default round-off value is 1 .01.0 .

When the round rule  parameter is set to RoundOffType.Ordinar yRoundOffType.Ordinar y , this function rounds to the nearest round-

off amount.

When the round rule  parameter is set to RoundOffType.RoundDownRoundOffType.RoundDown, this function rounds towards zero to

the nearest round-off amount.

When the round rule  parameter is set to RoundOffType.RoundUpRoundOffType.RoundUp, this function rounds away from zero to

the nearest round-off amount.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-other-roundamount.md


Remarks

Example

Additional resources

NOTENOTE

When the round rule  parameter is set to RoundOffType.Ordinar yRoundOffType.Ordinar y , this function behaves like the MROUND

Excel function and the ROUND X++ function.

To round a numeric value to a specified number of decimal places, use the ROUND function.

If the model.RoundOffmodel.RoundOff  parameter is set to RoundOffType.Ordinar yRoundOffType.Ordinar y , 

ROUNDAMOUNT (7.45, 1.05, model.RoundOff)  returns 7.35.

If the model.RoundOffmodel.RoundOff  parameter is set to RoundOffType.RoundDownRoundOffType.RoundDown, 

ROUNDAMOUNT (7.45, 1.05, model.RoundOff)  returns 7.35.

If the model.RoundOffmodel.RoundOff  parameter is set to RoundOffType.RoundUpRoundOffType.RoundUp, 

ROUNDAMOUNT (7.45, 1.05, model.RoundOff)  returns 8.4.

Other (business domain–specific) functions

Mathematical functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://support.office.com/article/mround-function-c299c3b0-15a5-426d-aa4b-d2d5b3baf427
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-ref/xpp-math-run-time-functions#round
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


TABLENAME2ID ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

TABLENAME2ID (text)

Arguments

Return values

Usage notes

Example

Additional resources

NOTENOTE

The TABLENAME2ID  function returns a numeric representation of the table ID for the specified table name as an

Integer value.

text : String

A text value that represents a valid table name.

Integer

The resulting numeric value.

Execution of this function can have different results in different instances of Microsoft Dynamics 365 Finance,

even if the same company name is used.

TABLENAME2ID ("Intrastat")  returns 15101510 .

Other (business domain–specific) functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-other-tablename2id.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


List of ER functions in the type conversion category
2/18/2021 • 2 minutes to read • Edit Online

Type conversion functions

F UN C T IO NF UN C T IO N DESC RIP T IO NDESC RIP T IO N

Int64Value This function returns an Int64 value that represents the
specified string.

IntValue This function returns an Int value that represents the
specified string.

NumberValue This function returns a Real value that is converted from the
specified String value. During the conversion, the specified
decimal and digit grouping separators are considered.

Value This function returns a Real value that is converted from the
specified String value.

Type conversion functions in the container category

F UN C T IO NF UN C T IO N DESC RIP T IO NDESC RIP T IO N

Base64StringToContainer This function converts the specified input of the String type
to a data item of the Container type.

Type conversion functions in the date and time category

F UN C T IO NF UN C T IO N DESC RIP T IO NDESC RIP T IO N

DateTimeValue This function returns a DateTime value that is converted
from a given String value in the specified format and in an
optionally specified culture to a date/time value.

DateToDateTime This function returns a DateTime value that is converted
from a given Date value to a date/time value in Coordinated
Universal Time (Greenwich Mean Time [GMT]).

DateValue This function returns a Date value that is converted from a
given String value in the specified format and in an
optionally specified culture to a date value.

Electronic reporting (ER) type conversion functions can be used to convert values between types. This topic

provides a summary of these functions.

The following table describes the type conversion functions in the container category.

The following table describes the type conversion functions in the date and time category.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-category-type-conversion.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/er-functions-category-container
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/er-functions-container-base64stringtocontainer


Type conversion functions in the list category

F UN C T IO NF UN C T IO N DESC RIP T IO NDESC RIP T IO N

List This function returns a Record list value as a new list that is
created from specified arguments of the Container (record)
type.

ListOfFields This function returns a Record list value that is created based
on the structure of a given argument of the Enumeration or
Container (record) type.

Split This function splits the specified String value into substrings
and returns the result as a new Record list value.

StringJoin This function returns a String value that consists of
concatenated values of the specified field from the specified
Record list value. The values can be separated by the
specified delimiter.

Type conversion functions in the text category

F UN C T IO NF UN C T IO N DESC RIP T IO NDESC RIP T IO N

Char This function returns a String value that represents a single
character that is referenced by the specified Unicode number.

GuidValue This function converts the specified input of the String type
to a data item of the GUID type.

NumberFormat This function returns a String value that represents the
specified number in the specified format and in an optionally
specified culture.

QrCode This function returns a Container value that presents the
Quick Response code (QR code) image for the specified
string in binary format.

Text This function returns a String value that represents the
specified number after it has been converted to a text string
that is formatted according to the server locale settings of
the current application instance.

Additional resources

The following table describes the type conversion functions in the list category.

The following table describes the type conversion functions in the text category.

Electronic Reporting overview

Formula designer in Electronic reporting

Electronic reporting formula language



NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


INT64VALUE ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax 1

INT64VALUE (text)

Syntax 2

INT64VALUE (number)

Arguments

Return values

Usage notes

Example 1

Example 2

Additional resources

The INT64VALUE  function returns an Int64 value that represents the specified string.

text : String

A text value that must be converted to an Int64 number.

number : Real or Integer

A numeric Real or Integer value that must be converted to an Int64 number.

Int64

The resulting numeric value.

Any decimal places are truncated.

INT64VALUE ("22565422744")  returns the Int64 value 2256542274422565422744 .

INT64VALUE ( VALUE("22565422744.77"))  returns the Int64 value 2256542274422565422744 .

Type conversion functions

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-conversion-int64value.md


NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


INTVALUE ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax 1

INTVALUE (text)

Syntax 2

INTVALUE (number)

Arguments

Return values

Usage notes

Example 1

Example 2

Additional resources

The INTVALUE  function returns an Int value that represents the specified string.

text : String

A text value that must be converted to an Int number.

number : Real or Integer

A numeric Real or Integer value that must be converted to an Int number.

Int

The resulting numeric value.

Any decimal places are truncated.

INTVALUE ("100.77")  returns the Int value 100100 .

INTVALUE (-100.77)  returns the Int value -100-100 .

Type conversion functions

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-conversion-intvalue.md


NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


NUMBERVALUE ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

NUMBERVALUE (text, decimal separator, digit grouping separator)

Arguments

Return values

Example

Additional resources

NOTENOTE

The NUMBERVALUE  function returns a Real value that is converted from the specified String value. During the

conversion, the specified decimal and digit grouping separators are considered.

text : String

A text value that must be converted to a Real number.

decimal separator : String

A decimal separator. It's used to separate the integer and fractional parts of a decimal number.

digit grouping separator : String

A digit grouping separator. It's used as the thousands separator.

Real

The resulting numeric value.

NUMBERVALUE( "1 234,56", ",", " ")  returns 1234.561234.56 .

Type conversion functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-conversion-numbervalue.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


VALUE ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax

VALUE (text)

Arguments

Return values

Usage notes

Example 1

Example 2

Additional resources

NOTENOTE

The VALUE  function returns a Real value that is converted from the specified string.

text : String

A string value that must be converted to a numeric value.

Real

The resulting numeric value.

Commas and dot characters (.) are considered decimal separators, and a leading hyphen (-) is used as a negative

sign. An exception is thrown at runtime if the specified string contains other non-numeric characters.

VALUE ("1 234,56")  throws an exception.

VALUE ("1234,56")  returns 1234.561234.56 .

Type conversion functions

Can you tell us about your documentation language preferences? Take a short survey.
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DATETIMEVALUE ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax 1

DATETIMEVALUE (text, format)

Syntax 2

DATETIMEVALUE (text, format, culture)

Arguments

Return values

Usage notes

Example 1

Example 2

The DATETIMEVALUE  function returns a DateTime value that is converted from a given text value in the specified

format and in an optionally specified culture to a date/time value. For information about the supported formats,

see standard and custom.

text : String

Text that represents the value to format.

format : String

The format of the given text.

culture : String

The culture that is used for formatting of the given text.

DateTime

The resulting date/time value.

When the culture isn't defined as an argument of the called function, the value of culture  is defined by the

calling context. For example, if the DATETIMEVALUE  function is called by using syntax 1 in an Electronic reporting

(ER) format for a FILEFILE element that is configured to use the German culture, the conversion will be done by

using the German culture. The default culture  value is EN-USEN-US .

DATETIMEVALUE ("21-Dec-2016 02:55:00", "dd-MMM-yyyy hh:mm:ss")  returns 2:55:00 AM on December 21,2:55:00 AM on December 21,

20162016 , based on the specified custom format and the default application's EN-USEN-US  culture.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-datetime-datetimevalue.md
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Additional resources

NOTENOTE

DATETIMEVALUE ("21-Gen-2016 02:55:00", "dd-MMM-yyyy hh:mm:ss", "IT")  returns 2:55:00 AM on December 21,2:55:00 AM on December 21,

20162016 , based on the specified custom format and culture.

However, DATETIMEVALUE ("21-Gen-2016 02:55:00", "dd-MMM-yyyy hh:mm:ss", "EN-US")  throws an exception to

inform the user that the specified string isn't recognized as a valid date/time value for the specified culture.

Date and time functions
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DATETODATETIME ER function
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Syntax

DATETODATETIME (date)

Arguments

Return values

Example 1

Example 2

Additional resources

NOTENOTE

The DATETODATETIME  function returns a DateTime value that is converted from a given date value to a date/time

value in Coordinated Universal Time (Greenwich Mean Time [GMT]).

date : Date

A date value that represents the date to convert.

DateTime

The resulting date/time value.

DATETODATETIME (CompInfo. 'getCurrentDate()')  returns the date of the current Microsoft Dynamics 365 Finance

session, December 24, 2015, as 12/24/2015 12:00:00 AM12/24/2015 12:00:00 AM. In this example, CompInfoCompInfo is an Electronic

reporting (ER) data source of the Finance and Operations/TableFinance and Operations/Table type, and it refers to the CompanyInfo table.

DATETODATETIME (DATEVALUE ("2019-11-12T16:00:00.0000000-07:00", "O"))  returns the date/time value

11/12/2019 12:00:00 AM11/12/2019 12:00:00 AM.

Date and time functions
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DATEVALUE ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax 1

DATEVALUE (text, format)

Syntax 2

DATEVALUE (text, format, culture)

Arguments

Return values

Usage notes

Example 1

Example 2

The DATEVALUE  function returns a Date value that is converted from a given text value in the specified format

and in an optionally specified culture to a date value. For information about the supported formats, see standard

and custom.

text : String

Text that represents the value to format.

format : String

The format of the given text.

culture : String

The culture that is used for formatting of the given text.

Date

The resulting date value.

When the culture isn't defined as an argument of the called function, the value of culture  is defined by the

calling context. For example, if the DATEVALUE  function is called by using syntax 1 in an Electronic reporting (ER)

format for a FILEFILE element that is configured to use the German culture, the conversion will be done by using the

German culture. The default culture  value is EN-USEN-US .

DATEVALUE ("21-Dec-2016", "dd-MMM-yyyy")  returns the date value December 21, 2016December 21, 2016 , based on the specified

custom format and the default application's EN-USEN-US  culture.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-datetime-datevalue.md
https://docs.microsoft.com/en-us/bingmaps/rest-services/common-parameters-and-types/supported-culture-codes
https://msdn.microsoft.com/library/az4se3k1(v=vs.110).aspx
https://msdn.microsoft.com/library/8kb3ddd4(v=vs.110).aspx


Additional resources

NOTENOTE

DATEVALUE ("21-Gen-2016", "dd-MMM-yyyy", "IT")  returns the date value Januar y 21, 2016Januar y 21, 2016 , based on the

specified custom format and culture.

However, DATEVALUE ("21-Gen-2016", "dd-MMM-yyyy", "EN-US")  throws an exception to inform the user that the

specified string isn't recognized as a valid date for the specified culture.

Date and time functions
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LIST ER function
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Syntax

LIST (record 1 [, record 2, …, record N])

Arguments

Return values

Usage notes

Example

Additional resources

The LIST  function returns a Record list value that consists of a new list of records that is created from the

specified arguments.

record 1 : Container (record)

A reference to a data source of the Record data type. This argument is required.

record N : Container (record)

A reference to a data source of the Record data type. These additional arguments are optional.

Record list

The resulting list of records.

The structure of the list that is created contains only the fields that are presented in the structure of every record

that is mentioned in the arguments.

You enter data source Record 1Record 1  of the Container type. This data source contains the following nested fields of

the Calculated field type:

Code:Code: This field contains an expression that returns a value of the String type.

Amount:Amount: This field contains an expression that returns a value of the Real type.

You then enter data source Record 2Record 2  of the Container type. This data source contains the following nested fields

of the Calculated field type:

Amount:Amount: This field contains an expression that returns a value of the Real type.

IsValid:IsValid: This field contains an expression that returns a value of the Boolean type.

In this case, the expression LIST('Record 1', 'Record 2')  returns a new list that contains two records. The

structure of this list consists of a single AmountAmount field of the Real type, because this field is the only field that is

presented in every argument of the called function.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-list-list.md
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List functions
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LISTOFFIELDS ER function
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Syntax 1

LISTOFFIELDS (path)

Syntax 2

LISTOFFIELDS (path, language)

Arguments

Return values

Usage notes

The LISTOFFIELDS  function returns a Record list value that is created based on the structure of the specified

argument of the Enumeration or Container (record) type.

path : Data source reference

The valid reference path of a data source of one of the following data types:

Model enumeration

Format enumeration

Application enumeration

Container (record)

language : String

Text that represents a language code.

Record list

The resulting list of records.

The list that is created consists of records that have the following fields:

NameName (String data type)

LabelLabel  (String data type)

Descr iptionDescr iption (String data type)

IsTranslatedIsTranslated (Boolean data type)

If the path  argument refers to a data source of the Container (Record) type, for every field of the referenced

container record, a new record is added to the list that is created. For every record that is created, the NameName

field returns the name of the field of the referenced container record that the current record was created for.

If the path  argument refers to a data source of one of the Enumeration types, for every enumeration value of

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-list-listoffields.md


Example 1

the referenced enumeration, a new record is added to the list that is created. For every record that is created, the

NameName field returns the value of the referenced enumeration that the current record was created for, the

Descr iptionDescr iption field returns the description of that enumeration, and the LabelLabel  field returns the label of that

enumeration.

At runtime, when syntax 1 is used, the LabelLabel  and Descr iptionDescr iption fields must return values that are based on the

language settings of the Electronic reporting (ER) format that is running:

If the labels and descriptions for the requested language are available, the LabelLabel  and Descr iptionDescr iption fields

return values that are based on that language, and the IsTranslatedIsTranslated field returns TrueTrue.

If the labels and descriptions for the requested language aren't available, the LabelLabel  and Descr iptionDescr iption fields

return values that are based on the default EN-USEN-US  language, and the IsTranslatedIsTranslated field returns FalseFalse.

At runtime, when syntax 2 is used, the LabelLabel  and Descr iptionDescr iption fields must return values that are based on the

language that is defined as the second argument of the called function:

If the labels and descriptions for the requested language are available, the LabelLabel  and Descr iptionDescr iption fields

return values that are based on that language, and the IsTranslatedIsTranslated field returns TrueTrue.

If the labels and descriptions for the requested language aren't available, the LabelLabel  and Descr iptionDescr iption fields

return values that are based on the EN-USEN-US  language, and the IsTranslatedIsTranslated field returns FalseFalse.

In the following illustration, an enumeration is introduced in an ER data model.

The following illustration shows these details:

The model enumeration is inserted into a report as a data source.

An ER expression uses the model enumeration as a parameter of the LISTOFFIELDS  function.

A data source of the Record list type is inserted into a report by using the ER expression that is created.

The following example shows the ER format elements that are bound to the data source of the Record list type

that was created by using the LISTOFFIELDS  function.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ger-listoffields-function-model-enumeration.png
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NOTENOTE

Example 2

IF (NOT (enumType_deCH.IsTranslated), enumType_de.Label, enumType_deCH.Label)

Additional resources

NOTENOTE

The following illustration shows the result when the designed format is run.

Based on the language settings of the parent FILEFILE and FOLDERFOLDER format elements, translated text for labels and

descriptions is entered in the output of the ER format.

You use the Calculated field data source type to configure enumType_deenumType_de and enumType_deCHenumType_deCH data sources

for the enumTypeenumType data model enumeration:

enumType_deenumType_de = LISTOFFIELDS (enumType, "de")

enumType_deCHenumType_deCH = LISTOFFIELDS (enumType, "de-CH")

In this case, you can use the following expression to get the label of the enumeration value in Swiss German, if

that translation is available. If the Swiss German translation isn't available, the label is in German.

List functions
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SPLIT ER function
2/18/2021 • 2 minutes to read • Edit Online

Syntax 1

SPLIT (input, length)

Syntax 2

SPLIT (input, delimiter)

Arguments

Return values

Usage notes

Example 1

The SPLIT  function splits the specified input string into substrings and returns the result as a new Record list

value.

This syntax is used to split the specified input string into substrings, each of which has the specified length.

This syntax is used to split the specified input string into substrings, based on the specified delimiter.

input : String

The text to split.

length : Integer

The maximum length of a single substring.

delimiter : String

A delimiter that is used to separate substrings.

Record list

The resulting list of records.

The record structure of the list that is returned consists of the ValueValue field of the String type. Every record of the

list that is returned contains generated substrings in this field.

If the delimiter  argument is empty, the new list that is returned consists of one record that has the ValueValue field

of the String type. This field contains the input text.

If the input  argument is empty, a new empty list is returned. If either the input  or delimiter  argument is

unspecified (null), an application exception is thrown.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-list-split.md


Example 2

Additional resources

NOTENOTE

SPLIT ("abcd", 3)  returns a new list that consists of two records that have the ValueValue field of the String type.

The ValueValue field in the first record contains the text "abc""abc", and the ValueValue field in the second record contains the

text "d""d".

SPLIT ("XAb aBy", "aB")  returns a new list that consists of three records that have the ValueValue field of the String

type. The ValueValue field in the first record contains the text "X""X", the ValueValue field in the second record contains the

text " "" ", and the ValueValue field in the third record contains the text "y""y".

List functions
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STRINGJOIN ER function
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Syntax

STRINGJOIN (list, field, delimiter)

Arguments

Return values

Example

Additional resources

NOTENOTE

The STRINGJOIN  function returns a String value that consists of concatenated values of the specified field from

the specified list. The values can be separated by the specified delimiter.

list : Record list

The valid path of a data source of the Record list data type.

field : Field

The valid path of a field of the String data type in the specified list.

delimiter : String

A delimiter that is used to separate substrings.

String

The resulting text value.

If you enter SPLIT("abc" , 1)  as data source DSDS , the expression STRINGJOIN (DS, DS.Value, "-")  returns "a-b-"a-b-

c"c".

List functions
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CHAR ER function
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Syntax

CHAR (number)

Arguments

Return values

Usage notes

Example

Additional resources

NOTENOTE

The CHAR  function returns a String value that presents a single character that is referenced by the specified

Unicode number.

number : Integer

A number that corresponds to an expected single character.

String

The resulting text value.

The string that this function returns depends on the encoding that is selected in the parent FILEFILE format element.

For a list of the supported encodings, see Encoding class.

CHAR (255)  returns "ÿ""ÿ".

Text functions

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-functions-text-char.md
https://msdn.microsoft.com/library/system.text.encoding(v=vs.110).aspx
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


GUIDVALUE ER function
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Syntax

GUIDVALUE (input)

Arguments

Return values

Usage notes

Example

Additional resources

NOTENOTE

The GUIDVALUE  function converts the specified input of the String type to a data item of the GUID type.

input : String

The valid path of a data source of the String type.

GUID

The resulting globally unique identifier (GUID) value.

To do a conversion in the opposite direction (that is, to convert specified input of the GUID data type to a data

item of the String data type), you can use the TEXT function.

You define the following data sources in your model mapping:

A myIDmyID data source of the Calculated field type that contains the expression 

GUIDVALUE ("AF5CCDAC-F728-4609-8C8B- A4B30B0C0AA0")

A UsersUsers  data source of the Table records type that refers to the UserInfo table

You can then use an expression such as FILTER (Users, Users.objectId = myID)  to filter the UserInfo table by the

objectIdobjectId field of the GUID data type.

Text functions
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NUMBERFORMAT ER function
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Syntax 1

NUMBERFORMAT (number, format)

Syntax 2

NUMBERFORMAT (number, format, culture)

Arguments

Return values

Usage notes

Example 1

Example 2

Additional resources

The NUMBERFORMAT  function returns a String value that presents the specified number in the specified format and

in an optionally specified culture. For information about the supported formats, see standard and custom.

number : Integer or Real

A numeric value that specifies the number that must be formatted.

format  : String

A String value that represents the format.

culture : String

A String value that represents the culture to use for formatting.

String

The resulting text value.

If the culture isn't defined as an argument of the called function, the context that this function is run in

determines the culture that is used to format numbers.

For the EN-USEN-US  culture, NUMBERFORMAT (0.45, "p")  returns "45.00 %""45.00 %", and NUMBERFORMAT (10.45, "#")  returns

"10""10".

NUMBERFORMAT (10/3, "F2", "de")  returns 3,333,33 , whereas NUMBERFORMAT (10/3, "F2", "en-us")  returns 3.333.33 .
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Text functions
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QRCODE ER function
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Syntax

QRCODE (text)

Arguments

Return values

Example

QRCODE (model.ListOfShelfLabels.LabelText)`

Additional resources

NOTENOTE

The QRCODE  function returns a Container value that presents the Quick Response code (QR code) image for the

specified string in binary format.

text : String

A String value that represents the original text.

Container

The resulting binary stream.

You can configure an Electronic reporting (ER) format to generate an outbound document in Microsoft Office

format (Excel workbooks or Word documents) by using a predefined template. This template may contain a

PicturePicture object (Excel workbook) or a Picture Content ControlPicture Content Control  (Word document) as a placeholder for a QR

code image. You need to add to the configured ER format a CellCell  element that will be used to fill this placeholder

in. To specify what information will be stored in a QR code, you need to define a binding for this CellCell  element.

For example, you can configure such binding as containing the following expression:

When you run the configured ER format, the text value of the LabelTextLabelText field of the model.L istOfShelfLabelsmodel.L istOfShelfLabels

data source will be used to generate a QR code image. This image will replace a QR code image placeholder in

the document template using to generate an outbound document. When this image of the generated document

is scanned, it returns the text that was taken from the LabelTextLabelText field of the model.L istOfShelfLabelsmodel.L istOfShelfLabels  data

source. For more information, see Embed images and shapes in documents that you generate by using ER.

Text functions
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TEXT ER function
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Syntax

TEXT (number)

Arguments

Return values

Usage notes

Example

Additional resources

NOTENOTE

The TEXT  function returns the specified number as a String value after it has been converted to a text string that

is formatted according to the server locale settings of the current application instance.

number : Integer or Real

A number that must be converted to a text string.

String

The resulting text value.

For values of the Real type, the string conversion is limited to two decimal places.

If the server locale of the Microsoft Dynamics 365 Finance instance is defined as EN-USEN-US , TEXT (NOW ())  returns

the current Finance session date, December 17, 2015, as the text string "12/17/2015 07:59:23 AM""12/17/2015 07:59:23 AM". 

TEXT (1/3)  returns "0.33""0.33".

Text functions
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Manage ER model mapping in separate ER
configurations
2/18/2021 • 5 minutes to read • Edit Online

Add a new ER model configuration

The following steps explain how a user assigned to the System administrator or Electronic reporting developer

role can manage Electronic reporting (ER) model mappings in separate ER configurations. In this task guide, you

will create required ER configurations for the sample company, Litware, Inc. To complete this task guide, you

must first complete the steps in the task guide, "ER Create a configuration provider" and mark it as active.

Because ER configurations are shared among companies, you can complete this task guide using the company

data set of your choice. The functionality for this task guide is available if you have installed one of the following

hotfixes: https://fix.lcs.dynamics.com/Issue/Resolved?kb=4012872 for the Dynamics AX 7.0 version or

https://fix.lcs.dynamics.com/Issue/Resolved?kb=4012871 for the Dynamics 365 for Operations version.

1. Go to Organization administration > Workspaces > Electronic reporting.

Verify that the configuration provider for the sample company Litware, Inc. is available and marked as

active. If you don't see this configuration provider, you must first complete the steps in the task guide,

Create a configuration provider, and mark it as active.

1. Click Reporting configurations.

2. Click Create configuration to open the drop dialog.

3. In the Name field, type 'Sample data model'.

4. Click Create configuration.

5. Click Designer.

6. Click New to open the drop dialog.

7. In the Name field, type 'Root'.

8. Click Add.

9. Click New to open the drop dialog.

10. In the Name field, type 'Company'.

11. Click Add.

12. In the Description field, enter the text, Description of the legal entity or company in which a user logged at

run-time.

13. Click Root reference.

14. Click OK.

15. Click Save.

16. Close the page.

17. Click Change status.

18. Click Complete.

19. Click OK.

Add a new model configuration. The name must be unique in the configurations tree.

Sample data model

Root

Company

Description of the legal entity or company in which a user logged at run-time.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-manage-model-mapping-configurations-july-2017.md
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Add a new ER model-mapping configuration

Add a new ER format configuration

1. Click Create configuration to open the drop dialog.

2. In the New field, enter 'Model Mapping based on data model Sample data model'.

3. In the Name field, type 'Sample mapping'.

4. Click Create configuration.

5. Expand the Prerequisites section.

6. Click Designer.

7. Click Designer.

8. In the tree, select 'Dynamics 365 for Operations\Table'.

9. Click Add root.

10. In the Name field, type 'Company'.

11. In the Table field, type 'CompanyInfo'.

12. Click OK.

13. In the tree, expand 'Company'.

14. In the tree, expand 'Company\find()'.

15. In the tree, select 'Company\find()\Name'.

16. Click Bind.

17. Click Save.

18. Close the page.

19. Close the page.

20. On the Action Pane, click Configurations.

21. Click User parameters.

22. Select Yes in the Run settings field.

23. Click OK.

24. Click Edit.

25. Select Yes in the Run Draft field.

Sample mapping

The Implementations prerequisites group has been added automatically. The group contains the

prerequisite component that refers to the parent data model configuration and is marked as

Implementation. This means that this Sample-mapping model-mapping configuration is considered

the implementation of the data model, Sample data model. Therefore, this component will force ER to

download the model-mapping configuration, Sample mapping from an ER repository when the model

configuration, Sample data model, is downloaded.

The created model-mapping configuration contains a new blank mapping with the same name as the

created configuration. When a selected parent model configuration contains model mappings, they

will be copied to a new model-mapping configuration.

Company

CompanyInfo

1. In the tree, select 'Sample data model'.

2. Click Create configuration to open the drop dialog.

3. In the New field, enter 'Format based on data model Sample data model'.

4. In the Name field, type 'Sample format'.

5. Click Create configuration.

Sample format



Add alternative ER model-mapping configuration

6. Click Designer.

7. Click Add root to open the drop dialog.

8. In the tree, select 'Text\String'.

9. Click OK.

10. Click the Mapping tab.

11. In the tree, expand 'model'.

12. In the tree, select 'model\Company'.

13. Click Bind.

14. Click Save.

15. Close the page.

16. Click Run.

17. Click OK.

Run the draft version of the created format for testing purposes.

On the Versions FastTab, click Run.

Review the output that contains the name of the company in which the user who is running this

format configuration is logged into. The created model-mapping configuration is used by this format

configuration because there is only one configuration available that contains required model

mappings.

1. In the tree, select 'Sample data model'.

2. Click Create configuration to open the drop dialog.

3. In the New field, enter 'Model Mapping based on data model Sample data model'.

4. In the Name field, type 'Sample mapping (alternative)'.

5. Click Create configuration.

6. Click Designer.

7. Click Designer.

8. In the tree, select 'Dynamics 365 for Operations\Table'.

9. Click Add root.

10. In the Name field, type 'Company'.

11. In the Table field, type 'CompanyInfo'.

12. Click OK.

13. Click Edit.

14. In the tree, select 'String\CONCATENATE'.

15. Click Add function.

16. In the tree, expand 'Company'.

17. In the tree, expand 'Company\find()'.

18. In the tree, select 'Company\find()\Name'.

19. Click Add data source.

20. In the Formula field, type a value.

21. In the tree, select 'Company\find()\Company(DataArea)'.

22. Click Add data source.

Sample mapping (alternative)

Company

CompanyInfo

CONCATENATE(Company.'find()'.Name, ";",



Use an existing ER model-mapping configuration

NOTENOTE

23. In the Formula field, type a value.

24. Click Save.

25. Close the page.

26. Click Save.

27. Close the page.

28. Close the page.

29. Select Yes in the Run Draft field.

CONCATENATE(Company.'find()'.Name, ";", Company.'find()'.DataArea)

1. In the tree, select 'Sample data model\Sample format'.

2. Click Run.

3. In the tree, select 'Sample data model\Sample mapping (alternative)'.

4. Select Yes in the Default for model-mapping field.

5. In the tree, select 'Sample data model\Sample format'.

6. Click Run.

7. Click OK.

The selected draft version of the ER format configuration can't be executed because there is more than

one model-mapping configuration available for the undefined data model that has been selected as

the data source of the running ER format.

Next, you will define the alternative model-mapping configuration as the one from which model

mappings will be used as data sources for running ER format.

The default model-mapping configuration is used by this format configuration for generating the

electronic document (the created output contains the company code).

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Add a new ER data model configuration

To complete the steps in this procedure, you must first complete the procedure, ER Create a configuration

provider and mark it as active.

This procedure shows how a model's root item can be selected as a data model definition for inserting an

Electronic reporting (ER) format configuration that is designed to generate electronic documents. In this

procedure, you will add a new ER format configuration for the sample company Litware, Inc.

This procedure is intended for users who have the System administrator or Electronic reporting developer role

assigned to them. The steps can be completed by using any dataset.

1. Go to Organization administration > Workspaces > Electronic reporting.

2. Click Reporting configurations.

Make sure that the configuration provider for the sample company, Litware, Inc., is available and

marked as Active. If you don't see this configuration provider, complete the steps in the procedure,

Create a configuration provider and mark it as active.

1. Click Create configuration to open the drop dialog.

2. In the Name field, type 'Payment model (fictitious)'.

3. Click Create configuration.

4. Click Designer.

5. Click New to open the drop dialog.

6. In the Name field, type 'Payments – credit transfer'.

7. Click Add.

8. Click New to open the drop dialog.

9. In the New node as a field, enter 'Model root'.

10. In the Name field, type 'Payments – direct debit'.

11. Click Add.

12. Click Save.

13. Close the page.

14. Click Change status.

15. Click Complete.

We add a new ER model configuration containing a data model that is designed to be used as data

source for generation ER reports.

Payment model (fictitious)

Open the ER designer to specify the structure of data model of this configuration.

Assume that we design the data model for payments business domain to support 2 payment methods

– credit transfer and direct debit ones.

Payments – credit transfer

Payments – direct debit

Complete the draft version of the model to make it available in new model mappings and formats.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-select-data-model-definition-creating-er-format-july-2017.md


Start to enter a new ER format configuration

Add a new ER model mapping configuration

Design ER model mappings

Start to enter another new ER format configuration

16. Click OK.

1. Click Create configuration to open the drop dialog.

2. In the New field, enter 'Format based on data model Payment model (fictitious)'.

3. In the Data model definition field, enter or select a value.

4. Close the page.

Note that all root items of the selected data model are currently available for selection as a data model

definition. You can continue to design your format by using any of the required root items of the data

model. A missing model mapping for the selected root item doesn't prevent you from continuing.

1. Click Create configuration to open the drop dialog.

2. In the New field, enter 'Model Mapping based on data model Payment model (fictitious)'.

3. In the Name field, type 'Payment model mappings (fictitious)'.

4. In the Data model definition field, enter or select a value.

5. Click Create configuration.

Payment model mappings (fictitious)

1. Click Designer.

2. Click Designer.

3. In the tree, select 'Dynamics 365 for Operations\Table records'.

4. Click Add root.

5. In the Name field, type 'Ledger'.

6. In the Table field, type 'LedgerJournalTrans'.

7. Click OK.

8. Click Save.

9. Close the page.

10. Close the page.

Use the ER designer to specify the model mappings for the required root items.

Simulate setting of selected model mapping for the selected model's root item.

LedgerJournalTrans

1. In the tree, select 'Payment model (fictitious)'.

2. Click Create configuration to open the drop dialog.

3. In the New field, enter 'Format based on data model Payment model (fictitious)'.

4. In the Data model definition field, enter or select a value.

5. Close the page.

Note that now only one root item is available to map to the application data sources. When at least

one model mapping is introduced, only the model's root items that are mapped to application data

sources can be selected as a model definition while the ER format is added.
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Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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This topic describes enhanced filtering capabilities for Regulatory Configuration Services (RCS) Global

repository, which have been improved to include the ability to filter with the following criteria:

Countr y/regionCountr y/region - Based on ISO country codes

TagsTags  types for :

Functional area

Feature area

Industry

Business document

To make it easier to discover specific or related configurations you can apply filters, either individually or as a

group. For example, to find a single type of 'configurable business documents that are related to vendor

invoices, you could apply a Business document typeBusiness document type filter to search for that type of document.

You can further refine the search by selecting document type, for example 'vendor invoice' and clicking ApplyApply

filterfilter . The following example shows the results when filtering on Business document typeBusiness document type with the document

type added.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/localizations/enhanced-filtering-global-repo.md
file:///T:/eiye/ac1a/dynamics365/finance/localizations/media/rcs-enhanced-filter-section.jpg
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Filtered results can be imported into a users RCS repository or a Dynamics 365 Finance environment, either

individually or as a set. To do this, select the group of configurations, and click Impor tImpor t.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/finance/localizations/media/rcs-enhanced-filtering-applied.jpg
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

NOTENOTE

You can use the new RAW XMLRAW XML  format element to design Electronic reporting (ER) formats that generate

outgoing documents in XML format. In some cases, you might prefer to add raw XML data to these reports for

one or more of the following reasons:

It's more convenient to use raw XML for the original design and ongoing maintenance of a report, because

the XML structure can be automatically generated by executing a runtime expression. Therefore, multiple

bindings don't have to be determined for multiple format elements at design time. It is possible when the

data sources that you're using contain information that can be used to make XML elements while the report

is generated.

No other method can be used to fill the report with XML content that was previously received and stored in

the system. For example, the XML response that is generated might have to contain the content of an XML

request that was sent earlier.

No other method can be used to insert characters into the generated document based on their numeric

codes. For some languages and characters, codes of this type don't exist. Examples include the Greek letter

rho (ρ) and HTML entity codes such as &eacute; for an e that has an acute accent (é).

Be aware that the framework doesn't control whether the XML content that is placed to the generated document by

using the RAW XMLRAW XML format element is correct.

To learn more about this feature, play the ER Use raw XML data to generate XML repor ts (Par t 1 : DesignER Use raw XML data to generate XML repor ts (Par t 1 : Design

data model)data model)  and ER Use raw XML data to generate XML repor ts (Par t 2 : Design and run repor t)ER Use raw XML data to generate XML repor ts (Par t 2 : Design and run repor t)  task

guides, which are part of the 7.5 .4 .3 Acquire/Develop IT ser vice/solution components (10677)7.5 .4 .3 Acquire/Develop IT ser vice/solution components (10677)  business

process, and can be downloaded from the Microsoft Download Center. These task guides walk you through the

process of configuring an ER format to insert raw XML data into generated files.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-generate-reports-raw-xml.md
https://go.microsoft.com/fwlink/?linkid=874684
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

You can design Electronic reporting (ER) formats to generate outgoing documents in various formats. When a

document is generated, an ER format calls data sources that were configured in a corresponding ER model

mapping. To configure access to application tables for record retrieval, you can use ER data sources of the TableTable

recordsrecords  type. When the accessing table is a shared table (that is, a table where data is saved without a company

identifier), this data source returns all records. When the accessing table is a company-dependent table (that is, a

table where data is saved per company), this data source returns only the records that have been saved for the

current company (that is, the company context that the ER format is running under).

Every data source of the Table recordsTable records  type in a model mapping can be now marked as a cross-company data

source. Therefore, you can use data sources of the Table recordsTable records  type to access cross-company data in

application tables.

If you mark a data source as cross-company, the following behavior occurs:

For a data source that refers to any shared table except CompanyInfo, the data source returns all records that

exist in the referenced table.

For a data source that refers to the CompanyInfo table, even though CompanyInfo is a shared table, the data

source returns the records that contain the identifier of a company from the defined scope.

For any company-dependent table, the data source returns the records of the referenced table that contain

the identifier of a company from the defined scope.

In the system query dialog box, when the Ask for quer yAsk for quer y  option is turned on for any data source that is marked

as cross-company, you can manually select one or more companies to include on the Company rangeCompany range tab.

Like other filters, the company filter is persisted as a last-used value for queries when you run an ER format. The filter isn't

automatically changed if you change the cross-company value for a data source. To use a different cross-company value

for another data source, delete the corresponding user-specific selection.

For every data source that is marked as cross-company, you can select the records that you want by using the

FILTERFILTER  and WHEREWHERE functions in ER expressions. The dataAreaIDdataAreaID field can also be used as a company identifier.

Currently, the dataAreaIDdataAreaID field is limited to the following types of conditions when the FILTERFILTER  function is used:

Only conditions that have a single dataAreaIDdataAreaID field comparison are supported.

Only comparisons that have expressions that don't depend on records list items are allowed.

Therefore, the following expression is valid.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-cross-company-data-sources.md


FILTER (MyTable, MyTable.dataAreaID = $StringUserInputParameter)
While shown below expressions will not pass the validation:
FILTER (MyTable, MyTable.dataAreaID = MyTable2RecordsList.MyField)
FILTER (MyTable, 
    OR(
        MyTable.dataAreaID = $StringUserInputParameter1,
        MyTable.dataAreaID = $StringUserInputParameter2
    )
)

NOTENOTE

By default, the scope includes all companies of the current application. However, it can be restricted. To restrict

the scope of cross-company data access for a single ER format, assign a specific organization hierarchy to the

format. When a hierarchy is defined for an ER format, only records for legal entities that are presented in the

assigned hierarchy are returned, even though the format calls cross-company data sources. When a reference to

a hierarchy that no longer exists is defined for an ER format, the default scope is applied, and the format calls

cross-company data sources. In this situation, records for all application companies are returned.

Note that when the Use draftUse draft option is turned on for the assigned to a single ER format organization hierarchy,

the legal entities from the draft version of this hierarchy will be used to identify the scope for cross-company

data sources. If the draft version does not exist, the legal entities from the last published version of this

organization hierarchy will be used for this.

Note that when the Use draftUse draft option is turned off for the assigned to a single ER format organization hierarchy,

the legal entities from the last published version of this organization hierarchy will be used to identify the scope

for cross-company data sources. Date effectiveness of organization hierarchies is not supported yet in the ER

framework.

The hierarchy can be assigned to a format in a specific page that can be accessed from the ER workspace or by

using the Organization administration > Electronic repor ting > Legal entity filter  for formatsOrganization administration > Electronic repor ting > Legal entity filter  for formats  menu

item. To access the page, the Maintain legal entity filters for formatMaintain legal entity filters for format privilege

(ERMaintainFormatMappingLegalEntityFilters) must be granted to a user. The scope restriction of hierarchy-

based legal entities for the format is applied in addition to the restriction that the user can manually specify in

the system query dialog box. The intersection of these restrictions is used when the format is run.

To learn more about this feature, play the task guide, ER Access records of company dependent tables inER Access records of company dependent tables in

cross-company modecross-company mode, which is part of the 7.5.4.3 Acquire/Develop IT service/solution components (10677)

business process, and can be downloaded from the Microsoft Download Center. This task guide walks you

through the process of configuring an ER model mapping and ER format to access application tables in cross-

company mode.

Download the following files to complete the task guide:

ER model configuration - CrossCompanyDataAccessModel.xml

ER format configuration - CrossCompanyDataAccessFormat.xml

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://go.microsoft.com/fwlink/?linkid=874684
https://go.microsoft.com/fwlink/?linkid=874111
https://go.microsoft.com/fwlink/?linkid=874111
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Upload the Payments data model configuration

Create a new format configuration

This topic explains how a user in the System Administrator or Electronic Reporting Developer role can create a

new Electronic reporting (ER) configuration that contains a template for generating electronic documents in

OPENXML format. This configuration will be used for processing vendor payments.

In this example, you will create a configuration for sample company, Litware, Inc. These steps can be performed

in GBSI company.

To complete these steps, you must first complete the steps in the "Create a configuration provider and mark it as

active" procedure. You must also have an Excel file which will be imported when creating the template. This file

can be accessed from the Template of Payment Report.

1. In the navigation pane, go to Modules > Organization administration > Workspaces > ElectronicModules > Organization administration > Workspaces > Electronic

repor tingrepor ting.

2. In the list, mark the configuration provider for sample company, Litware, Inc. If you don't see this

configuration provider, you must first complete the steps in Create configuration providers and mark them as

active.

3. Select Set activeSet active.

4. Select Repositor iesRepositor ies . Select a repository for the Operations Resources type, if available. If its available, skip

the following steps about creating a new repository.

5. Select AddAdd to open the drop dialog.

6. In the Configuration repositor y typeConfiguration repositor y type field, enter Operations resourcesdd .

7. Select Create repositor yCreate repositor y .

8. Select OKOK.

9. Select OpenOpen.

10. In the tree, select Payment modelPayment model .

11. Select Impor tImpor t. Import this data model. It will be used as a data source in a new format configuration. Skip

this step if this configuration has been already imported.

12. Select YesYes .

13. Close the pages until you return to the Electronic reporting page.

1. Select Repor ting configurationsRepor ting configurations .

2. In the tree, select Payment modelPayment model .

3. Select Create configurationCreate configuration to open the drop dialog.

4. In the NewNew  field, enter Format based on data model PaymentModel . Create a format that is based on the

PaymentModel data model.

5. In the NameName field, type Sample worksheet report . Sample worksheet report

6. In the Descr iptionDescr iption field, type Sample worksheet report for vendors' payments . Sample worksheet report for

vendors' payments.

7. In the Data model definitionData model definition field, enter or select a value. Select the CustomerCreditTransferInitiationCustomerCreditTransferInitiation

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-design-reports-openxml-2016-11.md
https://go.microsoft.com/fwlink/?linkid=862266


Design a new document in OPENXML worksheet format

Create a new data source to calculate totals by currency codes

Map format components to data sources

definition.

8. Select Create configurationCreate configuration.

1. In the tree, select Payment model\Sample worksheet repor tPayment model\Sample worksheet repor t.

2. Select DesignerDesigner .

3. On the Action Pane, select Impor tImpor t.

4. Select Impor t from ExcelImpor t from Excel .

5. Select AttachmentsAttachments . Attach the existing Excel document as a template.

6. Select NewNew .

7. Select FileFile. Point to the existing Excel file.

8. Close the page.

9. In the TemplateTemplate field, enter or select a value. Select the attached Excel file to be used as a template.

10. Select OKOK. Note that ER format components have been created in the designing format based on the

structure of the referring MS Excel document (named ranges).

1. Select the MappingMapping tab.

2. Select Add rootAdd root to open the drop dialog.

3. In the tree, select Functions\Group byFunctions\Group by .

4. In the NameName field, type PaymentByCurrency .

5. Select Edit group byEdit group by .

6. In the tree, expand modelmodel , then select model\Paymentsmodel\Payments .

7. Select Add field toAdd field to.

8. Select What to groupWhat to group.

9. In the tree, expand model\Paymentsmodel\Payments , then select model\Payments\Currencymodel\Payments\Currency .

10. Select Add field toAdd field to.

11. Select Grouped fieldsGrouped fields .

12. In the tree, select model\Payments\Instructed Amount(InstructedAmount)model\Payments\Instructed Amount(InstructedAmount) .

13. Select Add field toAdd field to, then select Aggregation fieldsAggregation fields .

14. In the MethodMethod field, select an option. Select the SUM aggregationSUM aggregation function.

15. In the NameName field, type TotalInstructuredAmount .

16. Select SaveSave.

17. Close the page.

18. Select OKOK.

1. In the tree, select model\Payments\Initiating Par ty(InitiatingPar ty)\Namemodel\Payments\Initiating Par ty(InitiatingPar ty)\Name and

Excel\Repor tHeader\CompanyNameExcel\Repor tHeader\CompanyName.

2. Select BindBind.

3. In the tree, select model\Payments\Creditor\Identification\Source ID(SourceID)model\Payments\Creditor\Identification\Source ID(SourceID)  and

Excel\PaymLines\VendAccountNameExcel\PaymLines\VendAccountName.

4. Select BindBind.

5. In the tree, select model\Payments\Creditor\Namemodel\Payments\Creditor\Name and Excel\PaymLines\VendNameExcel\PaymLines\VendName.

6. Select BindBind.



Use the created configuration for payments processing

Use the created configuration for testing of payment journals
processing

7. In the tree, select model\Payments\Creditor Agent(CreditorAgent)\Namemodel\Payments\Creditor Agent(CreditorAgent)\Name and

Excel\PaymLines\BankExcel\PaymLines\Bank.

8. Select BindBind.

9. In the tree, select model\Payments\Creditor Agent(CreditorAgent)\Routingmodel\Payments\Creditor Agent(CreditorAgent)\Routing

Number(RoutingNumber)Number(RoutingNumber)  and Excel\PaymLines\RoutingNumberExcel\PaymLines\RoutingNumber .

10. Select BindBind.

11. In the tree, select model\Payments\Creditor Account(CreditorAccount)\Identification\Numbermodel\Payments\Creditor Account(CreditorAccount)\Identification\Number  and

Excel\PaymLines\AccountNumberExcel\PaymLines\AccountNumber .

12. Select BindBind.

13. In the tree, select model\Payments\Instructed Amount(InstructedAmount)model\Payments\Instructed Amount(InstructedAmount)  and

Excel\PaymLines\DebitExcel\PaymLines\Debit.

14. Select BindBind.

15. In the tree, select model\Payments\Currencymodel\Payments\Currency  and Excel\PaymLines\CurrencyExcel\PaymLines\Currency .

16. Select BindBind.

17. In the tree, select PaymentByCurrency\grouped\CurrencyPaymentByCurrency\grouped\Currency  and

Excel\Summar yLines\Summar yCurrencyExcel\Summar yLines\Summar yCurrency .

18. Select BindBind.

19. In the tree, select PaymentByCurrency\aggregated\TotalInstructuredAmountPaymentByCurrency\aggregated\TotalInstructuredAmount and

Excel\Summar yLines\Summar yAmountExcel\Summar yLines\Summar yAmount.

20. Select BindBind.

21. In the tree, select PaymentByCurrencyPaymentByCurrency  and Excel\Summar yLinesExcel\Summar yLines .

22. Select BindBind.

23. In the tree, select model\Paymentsmodel\Payments  and Excel\PaymLinesExcel\PaymLines .

24. Select BindBind.

25. Select SaveSave, then close the page.

1. Select Change statusChange status .

2. Select CompleteComplete.

3. Select OKOK.

4. In the navigation pane, go to Modules > Accounts payable > Payment setup > Methods of paymentModules > Accounts payable > Payment setup > Methods of payment.

5. Use the Quick Filter to filter on the Method of paymentMethod of payment field with a value of ElectronicElectronic.

6. Select EditEdit.

7. Expand the File formatsFile formats  section.

8. Select YesYes  in the Generic electronic repor tingGeneric electronic repor ting field.

9. In the Expor t format configurationExpor t format configuration field, enter or select a value. Select the Sample worksheet repor tSample worksheet repor t

configuration.

10. Select SaveSave.

11. Close the page.

1. In the navigation pane, go to Modules > Accounts payable > Payments > Payment journalModules > Accounts payable > Payments > Payment journal .

2. Select NewNew  to create a new payment journal.

3. In the NameName field, type VendPayVendPay .

4. Select L inesLines .
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5. In the AccountAccount field, specify the values GB_SI_000001 .

6. Set DebitDebit to 1000 .

7. Select NewNew .

8. In the AccountAccount field, specify the values GB_SI_000005 .

9. Set DebitDebit to 2000 .

10. In the CurrencyCurrency  field, type EUR .

11. In the Offset accountOffset account field, specify the values GBSI OPER .

12. In the Method of paymentMethod of payment field, type Electronic .

13. Select SaveSave.

14. Select Generate paymentsGenerate payments .

15. In the Method of paymentMethod of payment field, type Electronic .

16. In the File nameFile name field, type Payments .

17. In the Bank accountBank account field, type GBSI OPER .

18. Select OKOK, then select OKOK again. Review the created worksheet, including details of payment lines as well as

totals for each currency code used in this payment message.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Prerequisites

Select the existing ER report configuration

To generate reports as Microsoft Word documents, you can configure a new Electronic reporting (ER) format.

Alternatively, you can reuse an ER format that was originally designed to generate reports as Excel workbooks.

In this case, you must replace the Excel template with a Word template.

The following procedures show how a user in either the System administrator role or the Electronic reporting

developer role can configure an ER format to generate reports as Word files by reusing an ER format that was

designed to generate reports as Excel files.

These procedures can be completed in the GBSI company.

To complete these procedures, you must first follow the steps in the Design a configuration for generating

reports in OPENXML format task guide.

You must also download and locally save the following templates for the sample report:

Template of Payment Report (SampleVendPaymDocReport.docx)

Bounded Template of Payment Report (SampleVendPaymDocReportBounded.docx)

These procedures are for a feature that was added in Dynamics 365 for Operations version 1611 (November

2016).

NOTENOTE

1. In Dynamics 365 Finance, go to Organization administrationOrganization administration > WorkspacesWorkspaces  > ElectronicElectronic

repor tingrepor ting.

2. Make sure that the L itware, Inc.L itware, Inc. configuration provider is selected as ActiveActive. If it isn't, follow the steps in

the Create configuration providers and mark them as active task guide.

3. Select Repor ting configurationsRepor ting configurations . You will reuse the existing ER configuration that was designed to

generate the report output in OPENXML format.

4. On the ConfigurationsConfigurations  page, in the configuration tree in the left pane, expand Payment modelPayment model , and

select Sample worksheet repor tSample worksheet repor t.

The draft version of the selected ER format can be edited on the VersionsVersions FastTab.

5. Select DesignerDesigner .

6. On the Format designerFormat designer  page, notice that the title of the root format element indicates that an Excel

template is currently used.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-design-configuration-word-2016-11.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/er-design-configuration-word
https://go.microsoft.com/fwlink/?linkid=862266
https://go.microsoft.com/fwlink/?linkid=862266


Review the downloaded Word template

Replace the Excel template with the Word template and add a custom
XML part

1. In the Word desktop application, open the SampleVendPaymDocRepor t.docxSampleVendPaymDocRepor t.docx template file that you

downloaded earlier.

2. Verify that the template contains only the layout of the document that you want to generate as ER output.

Currently, the Excel document is used as a template to generate the output in OPENXML format. You will replace

this template with the SampleVendPaymDocReport.docx Word template file that you downloaded earlier. You

will also extend the Word template by adding a custom XML part.

1. In Finance, on the Format designerFormat designer  page, on the FormatFormat tab, select AttachmentsAttachments .

2. On the AttachmentsAttachments  page, select DeleteDelete to remove the existing Excel template. Select YesYes  to confirm the

change.



  Get a Word document that has a custom XML part and do data
mapping

NOTENOTE

3. Select NewNew  > FileFile.

You must select a document type that has been configured in the ER parameters to store templates of ER formats.

4. Select BrowseBrowse, and then browse to and select the SampleVendPaymDocRepor t.docxSampleVendPaymDocRepor t.docx file that you

downloaded earlier.

5. Select OKOK.

6. Close the AttachmentsAttachments  page.

7. On the Format designerFormat designer  page, in the TemplateTemplate field, enter or select the

SampleVendPaymDocRepor t.docxSampleVendPaymDocRepor t.docx file to use that Word template instead of the Excel template that

was previously used.

8. Select SaveSave.

In addition to storing configuration changes, the SaveSave action updates the attached Word template. The

hierarchical structure of the designed format is added to the attached Word document as a new custom

XML part that is named Repor tRepor t. The attached Word template contains the layout of the document that

will be generated as ER output and the structure of data that ER will enter in that template at runtime.

9. Notice that the title of the root format element indicates that a Word template is currently used.

10. On the FormatFormat tab, select AttachmentsAttachments .

You can now map the elements of the Repor tRepor t custom XML part to the content controls of the Word document.

If you're familiar with the process of designing Word documents as forms that contain content controls that are

mapped to elements of custom XML parts, complete all steps in the next procedure to create the document. For

more information, see Create forms that users complete or print in Words. Otherwise, skip the next procedure.

1. In Finance, on the AttachmentsAttachments  page, select OpenOpen to download the selected template from Finance and

store it locally as a Word document.

https://docs.microsoft.com/en-us/office/client-developer/word/content-controls-in-word
https://docs.microsoft.com/en-us/visualstudio/vsto/custom-xml-parts-overview?view=vs-2019
https://support.office.com/article/Create-forms-that-users-complete-or-print-in-Word-040c5cc1-e309-445b-94ac-542f732c8c8b


Review the Word template where the custom XML part is mapped to
content controls

Upload the Word template where the custom XML part is mapped to
content controls

NOTENOTE

2. In the Word desktop application, open the document that you just downloaded.

3. On the DeveloperDeveloper  tab, select XML Mapping PaneXML Mapping Pane.

If the DeveloperDeveloper  tab doesn't appear on the ribbon, customize the ribbon to add it.

4. In the XML MappingXML Mapping pane, in the Custom XML Par tCustom XML Par t field, select the Repor tRepor t custom XML part.

5. Map the elements of the selected Repor tRepor t custom XML part and the content controls of the Word

document.

6. Save the updated Word document locally as SampleVendPaymDocRepor tBounded.docxSampleVendPaymDocRepor tBounded.docx.

1. In the Word desktop application, open the SampleVendPaymDocRepor tBounded.docxSampleVendPaymDocRepor tBounded.docx template file.

2. Verify that the template contains the layout of the document that you want to generate as ER output. The

content controls that are used as placeholders for data that ER will enter in this template at runtime are

based on the mappings that are configured between elements of the Repor tRepor t custom XML part and the

content controls of the Word document.

1. In Finance, on the AttachmentsAttachments  page, select DeleteDelete to remove the Word template that has no mappings

between elements of the Repor tRepor t custom XML part and content controls. Select YesYes  to confirm the

change.

2. Select NewNew  > FileFile to add a new template file that contains mappings between elements of the Repor tRepor t

custom XML part and content controls.



Mark the configured format as runnable

Run the format to create output in Word format

NOTENOTE
You must select a document type that has been configured in the ER parameters to store templates of ER formats.

3. Select BrowseBrowse, and then browse to and select the SampleVendPaymDocRepor tBounded.docxSampleVendPaymDocRepor tBounded.docx file

that you downloaded or prepared by completing the procedure in the Get a Word that has a custom XML

part to do data mapping section.

4. Select OKOK.

5. Close the AttachmentsAttachments  page.

6. On the Format designerFormat designer  page, in the TemplateTemplate field, select the document that you just downloaded.

7. Select SaveSave.

8. Close the Format designerFormat designer  page.

To run the draft version of the editable format, you must make it runnable.

1. In Finance, on the ConfigurationsConfigurations  page, on the Action Pane, on the ConfigurationsConfigurations  tab, in the AdvancedAdvanced

settingssettings  group, select User parametersUser parameters .

2. In the User parametersUser parameters  dialog box, set the Run settingsRun settings  option to YesYes , and then select OKOK.

3. Select EditEdit to make the current page editable, as required.

4. For the currently selected Sample worksheet repor tSample worksheet repor t configuration, set the Run DraftRun Draft option to YesYes .

5. Select SaveSave.

1. In Finance, go to Accounts payableAccounts payable > PaymentsPayments  > Payment journalPayment journal .

2. In a payment journal that you entered earlier, select L inesLines .

3. On the Vendor paymentsVendor payments  page, select all rows in the grid.

4. Select Payment statusPayment status  > NoneNone.

5. On the Action Pane, select Generate paymentsGenerate payments .

6. In the dialog box that appears, follow these steps:

a. In the Method of paymentMethod of payment field, select ElectronicElectronic.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/er-quick-start2-customize-report


Additional resources

NOTENOTE

b. In the Bank accountBank account field, select GBSI OPERGBSI OPER .

c. Select OKOK.

7. In the Electronic repor t parametersElectronic repor t parameters  dialog box, select OKOK.

8. The generated output is presented in Word format and contains the details of the processed payments.

Analyze the generated output.

Design a new ER configuration to generate reports in Word format

Embed images and shapes in documents that you generate by using ER

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/er-design-configuration-word
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Design ER configurations to fill in PDF templates
2/18/2021 • 14 minutes to read • Edit Online

Prerequisites

C O N T EN T  DESC RIP T IO NC O N T EN T  DESC RIP T IO N F IL E  N A M EF IL E  N A M E

Template for the first page of the report IntrastatReportTemplate1.pdf

Template for other pages of the report IntrastatReportTemplate2.pdf

Sample ER format - PDF Intrastat report (PDF).version.1.1.xml

Sample ER format - Excel Intrastat (import from Excel).version.1.1.xml

Sample dataset Intrastat sample data.xlsx

Design the format configuration
Get access to the list of configurations provided by MicrosoftGet access to the list of configurations provided by Microsoft

The procedures in this topic are examples that show how a user in either the System administratorSystem administrator  role or the

Electronic repor ting developerElectronic repor ting developer  role can configure an Electronic reporting (ER) format that generates reports

as PDF files by using fillable PDF documents as report templates. These steps can be performed in any company

of Dynamics 365 Finance or Regulatory Configuration Services (RCS).

Before you begin, you must have one of the following types of access, depending on the service that you use to

complete the procedures in this topic:

Access to Finance for one of the following roles:

Electronic reporting developer

Electronic reporting functional consultant

System administrator

Access to RCS for one of the following roles:

Electronic reporting developer

Electronic reporting functional consultant

System administrator

You must also complete the Create configuration providers and mark them as active procedure.

Finally, you must download the following files from CustomerSource.

1. Go to Organization administration > Workspaces > Electronic repor tingOrganization administration > Workspaces > Electronic repor ting.

2. Make sure that the L itware, Inc.L itware, Inc. provider is available and marked as active.

3. On the tile for the MicrosoftMicrosoft provider, select Repositor iesRepositor ies .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-fillable-pdf.md
https://go.microsoft.com/fwlink/?linkid=874111
https://mbs.microsoft.com/Files/public/CS
https://mbs.microsoft.com/Files/public/CS/AX/IntrastatReportTemplate2.pdf
https://mbs.microsoft.com/Files/public/CS/AX/IntrastatreportPDFversion11.xml
https://mbs.microsoft.com/Files/public/CS/AX/IntrastatimportfromExcelversion11.xml
https://mbs.microsoft.com/Files/public/CS/AX/Intrastatsampledata.xlsx


Get the model configurations provided by MicrosoftGet the model configurations provided by Microsoft

Create a new format configurationCreate a new format configuration

NOTENOTE
If a repository of the LCSLCS type already exists, skip the remaining steps of this procedure.

4. Select AddAdd.

5. In the drop-down dialog box, in the Configuration repositor y typeConfiguration repositor y type field group, select the LCSLCS  option.

6. Select Create repositor yCreate repositor y .

7. Select OKOK.

NOTENOTE

1. On the left side of the Configuration repositor iesConfiguration repositor ies  page, select the Show filtersShow filters  button (the funnel

symbol).

2. Add a filter for a value of LCSLCS  in the TypeType field, and use the begins withbegins with operator.

3. Select ApplyApply .

4. Select OpenOpen.

5. In the tree, select Intrastat modelIntrastat model .

6. On the VersionsVersions  FastTab, select version 11 .

If the Impor tImpor t  button on the VersionsVersions FastTab is unavailable, skip the remaining steps of this procedure.

7. Select Impor tImpor t.

8. Select YesYes  to confirm the import of the selected version of the Intrastat modelIntrastat model  model configuration.

NOTENOTE

NOTENOTE

1. In the Electronic repor tingElectronic repor ting workspace, select the Repor ting configurationsRepor ting configurations  tile.

2. In the tree, select Intrastat modelIntrastat model .

3. Select Create configurationCreate configuration.

If the Create configurationCreate configuration button isn't available, you must turn on design mode on the Electronic repor tingElectronic repor ting

parametersparameters  page that can be opened from the Electronic repor tingElectronic repor ting workspace.

4. In the drop-down dialog box, in the NewNew  field group, select the Format based on data modelFormat based on data model

IntrastatIntrastat option.

5. In the NameName field, enter Intrastat repor t (PDF)Intrastat repor t (PDF) .

6. In the Descr iptionDescr iption field, enter Intrastat repor t in PDF formatIntrastat repor t in PDF format.

The active configuration provider is automatically entered. This provider will be able to maintain this configuration.

Although other providers can use this configuration, they won't be able to maintain it.



Design the format of an electronic documentDesign the format of an electronic document

7. Optional: In the Format typeFormat type field, you can select a specific format of electronic document. If you select

PDFPDF , at design time, the ER Operations designer will offer just the format elements that are applicable

only to documents that are generated in PDF format (PDF\FilePDF\File, PDF\PDF MergerPDF\PDF Merger , etc.). If you leave this

field blank, a format of electronic document will be specified at design time in the ER Operations designer

when a first format element will be added. For example, if you add the Excel\FileExcel\File as the first format

element, the ER Operations designer will offer you just the format elements that are applicable only to

documents that are generated in Excel format (Excel\CellExcel\Cell , Excel\RangeExcel\Range, etc.). format.

8. Select Create configurationCreate configuration.

A new ER format configuration is created. You can use the draft version of this configuration to store the ER

format component that is designed to generate electronic documents in PDF format.

Next, in the ER format configuration that you created, you will design the ER format that generates the IntrastatIntrastat

controlcontrol  report in PDF format. The first page of this report must show a summary of the report and details of

the foreign trade transactions that are reported on. The other pages must show only details of the foreign trade

transactions that are reported on. Because the report pages that are generated must have different layouts, two

different templates in PDF format will be used in the ER format.

In any PDF viewer, open the PDF templates that you downloaded. Notice that each template contains multiple

fields that must be filled in. In each template, details of foreign trade transactions are presented as 42 rows, each

of which has nine fields. The row number appears at the end of each field's name (for example, Date 1Date 1…DateDate

4242  and Commodity 1Commodity 1…Commodity 42Commodity 42 ).

The following illustration shows the PDF template for the first page of the report.

The following illustration shows the PDF template for other pages of the report.



1. On the ConfigurationsConfigurations  page, select DesignerDesigner .

2. Select Add rootAdd root.

3. In the drop-down dialog box, in the tree, select PDF > PDF MergerPDF > PDF Merger .

When you select the PDF MergerPDF Merger  element as the root element of the format, all PDF documents that are

generated at run time will be merged into a single final PDF document. If you need only one PDF

template to generate all the required documents by using the ER format that you design, you can select

PDF filePDF file as the root element.

4. In the NameName field, enter OutputOutput.

5. In the Language preferencesLanguage preferences  field, select User preferenceUser preference. The report will be generated in the

preferred language of the user who runs it.

6. In the Culture preferencesCulture preferences  field, select User preferenceUser preference. Values and dates that are presented on the

pages of the report will be formatted based on the preferred locale of the user who runs the report.

7. Select OKOK.

8. On the Action Pane, on the Impor tImpor t tab, select Impor t from PDFImpor t from PDF .

When a fillable PDF document is imported as a template for this ER format, all the required ER format

elements (PDF filePDF file, Field groupField group, and FieldField elements) are automatically created in the format that is

designed, based on the structure of the PDF document that is imported.

9. Select BrowseBrowse. Navigate to and select the IntrastatRepor tTemplate1.pdfIntrastatRepor tTemplate1.pdf file that you downloaded

earlier as a prerequisite.

10. Select OKOK.

The selected file is loaded, and the TemplateTemplate field in the Impor t from PDFImpor t from PDF dialog box is filled in.

11. Set the Group fieldsGroup fields  option to YesYes . If the selected PDF document contains any field groups, they will be

used to group the ER format elements that are created. A Field groupField group format element will be created for

this purpose.

If this option is set to NoNo, the required ER format elements will be created as a flat list of elements that

are nested under the PDF FilePDF File format element that is created.

12. Select OKOK.



13. In the tree, expand OutputOutput.

Notice that the PDF FilePDF File component has been automatically created to manage the creation of the first

page of the report that is generated at run time.

14. In the tree, expand Output > PDF FileOutput > PDF File.

Notice that the structured list of format elements has been automatically created in this ER format, based

on the structure of the fillable PDF document that you imported earlier.

15. In the tree, select Output > PDF FileOutput > PDF File.

16. In the NameName field, enter Page 1Page 1 .

This format element will be used to generate the first page of the Intrastat controlIntrastat control  report. That page

will show a summary of the report and details of foreign trade transactions.

If you leave the Language preferencesLanguage preferences  field blank, the Language preferencesLanguage preferences  setting of the parent

PDF MergerPDF Merger  element will determine the language of the report that is generated by using this format

element. You can select another value to override the setting of the parent element.

If you leave the Culture preferencesCulture preferences  field blank, the Culture preferencesCulture preferences  setting of the parent PDFPDF

MergerMerger  element will determine the locale of the report that is generated by using this format element.

The locale determines the format of values and dates on the pages of the report. You can select another

value to override the setting of the parent element.

17. On the Action Pane, select the Impor tImpor t tab. Notice that the Update from PDFUpdate from PDF button has become

available for selected format element, PDF FilePDF File.

You can use this button to import the updated PDF template to the edited format. When the updated PDF

template is imported, the list of format elements will be changed accordingly:

For any new fields in the updated PDF template, new format elements are created in the edited ER

format.

If the updated PDF template no longer includes fields that correspond to any existing format elements

in the edited ER format, those format elements are deleted from the ER format.

18. On the FormatFormat tab, select AttachmentsAttachments .

Notice that the imported PDF document is attached to the edited ER format.



Import the format configurationImport the format configuration

Analyze the format configuration
Format layoutFormat layout

19. Continue to design this format by importing the second PDF template, adding necessary bindings to data

sources, and so on.

20. Select SaveSave.

21. Close the page.

22. Select DeleteDelete.

23. Select YesYes .

To learn how new PDF MergerPDF Merger , PDF FilePDF File, Field groupField group and FieldField format elements can be used to generate

documents in PDF format, you can import and analyze the sample ER format.

Next, you will import the sample ER format that you previously downloaded to generate the Intrastat controlIntrastat control

report in PDF format. The first page of the report must show a summary of the report and details of the foreign

trade transactions that are reported on. The other pages must show only details of the foreign trade transactions

that are reported on.

1. On the ConfigurationsConfigurations  page, select Exchange > Load from XML fileExchange > Load from XML file.

2. Select BrowseBrowse. Navigate to and select the Intrastat repor t (PDF).version.1.1 .xmlIntrastat repor t (PDF).version.1.1 .xml  file that you

downloaded earlier as a prerequisite.

3. Select OKOK.

1. On the ConfigurationsConfigurations  page, in the tree, select Intrastat model > Intrastat repor t (PDF)Intrastat model > Intrastat repor t (PDF) .

2. Select DesignerDesigner .

3. Select Show detailsShow details .

4. In the tree, expand Output: PDF MergerOutput: PDF Merger .

Notice that this ER format contains two PDF FilePDF File elements, each of which uses a different PDF template.

One template is used to generate the first page of the report in PDF format, and the other template is

used to generate the other pages.



Format mappingFormat mapping

5. In the tree, expand Output: PDF Merger > Page 1: PDF File (IntrastatRepor tTemplate1)Output: PDF Merger > Page 1: PDF File (IntrastatRepor tTemplate1) .

6. In the tree, expand Output: PDF Merger > Page N: PDF File (IntrastatRepor tTemplate2)Output: PDF Merger > Page N: PDF File (IntrastatRepor tTemplate2) .

Notice that, because the content of the two PDF templates differs, the structure of the nested format

elements for the two PDF FilePDF File elements also differs.

1. On the Format designerFormat designer  page, select the MappingMapping tab.

2. In the tree, expand Paging > PagesPaging > Pages .

Note the following details:

The Output > Page 1Output > Page 1  format element of the PDF FilePDF File type isn't bound to any data source, and

the EnabledEnabled expression of this format element is empty. Therefore, at run time, the

IntrastatRepor tTemplate1IntrastatRepor tTemplate1  PDF template will be filled in only one time when an individual PDF

document is generated.

The Output > Page NOutput > Page N format element of the PDF FilePDF File type is bound to the Paging.PageNPaging.PageN data

source of the Record listRecord list type, and the EnabledEnabled expression of this format element is empty.

Therefore, at run time, the IntrastatRepor tTemplate2IntrastatRepor tTemplate2  PDF template will be filled in for each

record from the bound record list when an individual PDF document is generated.

Because the Page 1: PDF FilePage 1: PDF File and Page N: PDF FilePage N: PDF File format elements are children of the

Output: PDF MergerOutput: PDF Merger  format element, all PDF documents that are filled in will be merged into a

single final PDF document.

The Paging.Page1Paging.Page1  and Paging.PageNPaging.PageN data sources are configured as filters of records from the

Paging.PagesPaging.Pages  data source. This data source is configured to split the whole set of foreign trade

transactions into batches. Each batch contains up to 42 records. The following ER expression is

used to split the transactions into batches:

SPLITLIST(Totals.CommodityRecord,42)

The Paging.PagesPaging.Pages  data source contains the Paging.Pages.EnumeratedPaging.Pages.Enumerated element that returns the

details of each record that is included in a batch. These details include the record's sequence in the

current batch (the Paging.Pages.Enumerated.NumberPaging.Pages.Enumerated.Number  field). The

Paging.Pages.Enumerated.NumberPaging.Pages.Enumerated.Number  field is used in the NameName expression of PDF FieldPDF Field format

elements to dynamically generate a field name that is based on the transaction number in a batch.

The field name that is generated is then used to fill in the correct PDF field in the PDF template that

is used.



The Output > Page N > Details 2Output > Page N > Details 2  format element of the PDF GroupPDF Group type is bound to the

Paging.PageN.EnumeratedPaging.PageN.Enumerated data source (or @.Enumerated@.Enumerated if the Relative pathRelative path view mode is

used) of the Record listRecord list type. Therefore, at run time, the nested elements of this PDF group will be

filled in for each record from the bound record list. In this way, individual PDF lines are virtually

generated when for each Nth of 42 records of the Paging.PageN.EnumeratedPaging.PageN.Enumerated list the following

PDF fields are filled in: Date N, Direction N, Commodity N, etc. Therefore, in this respect, the

behavior of this Field groupField group format element resembles the behavior of the XML > SequenceXML > Sequence

and Text > SequenceText > Sequence format elements.

3. In the tree, expand Output > Page N > Details2Output > Page N > Details2 .

4. In the tree, select Output > Page N > Details2 > PageFooterOutput > Page N > Details2 > PageFooter .

Notice that the NameName attribute of this format element is defined as PageFooterPageFooter . Also notice that the

NameName expression of the format element is empty.

5. In the tree, select Output > Page N > Details2 > Correction 1Output > Page N > Details2 > Correction 1 .

Notice that the NameName attribute of this format element is defined as Correction 1Correction 1 . Also notice that the

NameName expression of the format element is defined as Paging.FldName("Correction",@.Number)Paging.FldName("Correction",@.Number) .

Note that the FieldField format element is used to fill in an individual field of a fillable PDF document that is defined

as a template of the parent PDF FilePDF File format element. The binding of the PDF FilePDF File format element or its nested

elements, if it has any nested elements, specifies the value that is entered in corresponding PDF fields. Different

properties of the FieldField format element can be used to specify which PDF field is filled in by an individual format

element:

On the FormatFormat tab, the NameName attribute of the format element

On the MappingMapping tab, the NameName expression of the format element

Because both properties are optional for a FieldField format element, the following rules are applied to specify the

target PDF field:

If the NameName attribute is blank, and the NameName expression returns an empty string at run time, an exception is

thrown at run time to notify the user that a PDF field can't be found in the PDF template that is being used to

fill in the PDF document.

If the NameName attribute is defined, and the NameName expression is blank, the PDF field that has the same name as

the NameName attribute of the format element is filled in.

If the NameName attribute is defined, and the NameName expression is configured, the PDF field that the same name

as the value that is returned by the NameName expression of the format element is filled in.



NOTENOTE

Run the format configuration
Import the format configurationImport the format configuration

A PDF check box can be filled in as selected in the following ways:

When the corresponding FieldField format element is bound to a data source field of the BooleanBoolean data type that has the

TrueTrue value

When the corresponding FieldField format element contains a nested StringString format element that is bound to a data

source field that has a text value of 11 , TrueTrue, or YesYes

Next, you will load the Intrastat (impor t from Excel)Intrastat (impor t from Excel)  sample ER format. This format is designed to parse a

user-selected Microsoft Excel workbook that simulates foreign trade transactions.

NOTENOTE

1. On the ConfigurationsConfigurations  page, select Exchange > Load from XML fileExchange > Load from XML file.

2. Select BrowseBrowse. Navigate to and select the Intrastat (impor t from Excel).version.1.1 .xmlIntrastat (impor t from Excel).version.1.1 .xml  file that you

downloaded earlier as a prerequisite.

3. Select OKOK.

4. In the tree, select Intrastat model > Intrastat (impor t from Excel)Intrastat model > Intrastat (impor t from Excel) .

5. Select EditEdit.

6. Set the Default for model mappingDefault for model mapping option to YesYes .

If you previously set the Default for model mappingDefault for model mapping option to YesYes for the Intrastat modelIntrastat model configuration or

another configuration that is nested under the Intrastat modelIntrastat model configuration, set this option to NoNo.

When the Default for model mappingDefault for model mapping option is set to YesYes , the imported Intrastat (impor t fromIntrastat (impor t from

Excel)Excel)  ER format is assigned as the default data source for the Intrastat repor t (PDF)Intrastat repor t (PDF)  format

configuration. Then, when the Intrastat repor t (PDF)Intrastat repor t (PDF)  format configuration is run, the content of the

Excel workbook that is parsed by the Intrastat (impor t from Excel)Intrastat (impor t from Excel)  ER format will simulate foreign

trade transactions that must be reported. The following illustration shows an example of an Excel

workbook.



Run the format configurationRun the format configuration
1. On the ConfigurationsConfigurations  page, in the tree, select Intrastat model > Intrastat repor t (PDF)Intrastat model > Intrastat repor t (PDF) .

2. Select RunRun.

3. Select BrowseBrowse. Navigate to and select the Intrastat sample data.xlsxIntrastat sample data.xlsx file that you downloaded earlier as a

prerequisite.

4. Select OKOK.

5. In the Repor t directionRepor t direction field, select BothBoth to fill in all transactions from the imported Excel workbook in the

PDF report that is generated.

6. Select OKOK.

7. Review the PDF document that is generated.

The follow illustration shows an example of the first page of the report that is generated.



Additional resources

NOTENOTE

The follow illustration shows an example of another page of the report that is generated.

ER Design a configuration for generating reports in OPENXML format (November 2016)

Design ER configurations to generate reports in Word format

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Embed an image in an Excel document

NOTENOTE

IMPORTANTIMPORTANT

You can use the Electronic reporting (ER) tool to design reports that you can run to generate required electronic

documents. You can use Microsoft Excel or Microsoft Word documents to specify the layout of a report. The ER

Operations designer lets you attach the Excel or Word document as a template for the report. The named

elements in the attached template are associated with the format elements of the ER report. Format elements of

the report are bound to data sources. These elements specify the data that will be entered, at run time, in the

documents that are generated.

This new functionality goes beyond existing ER capabilities for creating documents in Microsoft Office formats.

For more information, play the following task guides. You can find these task guides under the 7.5.4.3

Acquire/Develop IT service/solution components (10677) business process.

ER Design a configuration for generating reports in OPENXML format

ER Design a configuration for generating reports in Microsoft WORD format

First, you must add a placeholder for the image in an Excel document. Open an Excel workbook, and add a

picture as a placeholder for the image that you will add later. Then use the ER tool to add a new ER format

configuration to include the report that you're designing. Attach the Excel workbook as a template for the format

of the report, and then import the content of the workbook into the ER format. The format definition will be

created automatically. The image placeholder that you added will be included in the ER format definition as a

CELLCELL  element.

You can manually specify the format definition instead of importing it. When you save your changes, the format will be

validated.

Next, bind the CELLCELL  element of the ER format to the field from the format's data source that provides the

picture's data in binary format at run time. When an ER data model is used as a format's data source, the data

type of the field must be CONTAINERCONTAINER . Currently, an ER data model field that has the CONTAINERCONTAINER  data type

can be bound to several types of data sources that return images in binary format. You can access a field in a

data table and a file that is attached to the data table's record by using the Document management framework.

If you want to fill the image placeholder in the document that you're creating by using the Excel template, the ER

format must contain the CELLCELL  element that refers to the named picture element in the Excel template. Otherwise, no

image placeholder will appear in the report's output. If the binding of a CELLCELL  element returns no data at run time, the

document that is generated will show the image placeholder from the template. To hide an image in the document

that you're generating, define a CELLCELL  element, and specify that the EnablingEnabling expression should return a value of

FALSEFALSE.

In the Excel template, use a unique name for every element. These elements include pictures and cells. If you duplicate

an element name, the content of the report that is generated will be ambiguous and confusing.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/electronic-reporting-embed-images-shapes.md


  

Embed a shape in an Excel document

NOTENOTE

IMPORTANTIMPORTANT

Embed an image in a Word document

IMPORTANTIMPORTANT

First, you must add a placeholder for the shape in an Excel document. Open an Excel workbook, and select

ShapeShape, Text boxText box, or WordAr tWordAr t as a placeholder for the shape. Then use the ER tool to add a new ER format

configuration to include the report that you're designing. Attach the Excel workbook as a template for the format

of the report, and then import the content of the workbook into the ER format. The format definition will be

created automatically. The shape placeholder that you added will be included in the ER format definition as a

CELLCELL  element that refers to the named Excel shape element.

You can manually specify the format definition instead of importing it. When you save your changes, the format will be

validated.

Next, bind the CELLCELL  element in the ER format to the field from the format's data source that provides the data at

run time. This data can be converted to a text string. When the CELLCELL  element in the ER format refers to a shape

element in the Excel template that supports text, the text that is provided through this binding at run time will be

shown in a shape in the document that is generated.

If you want to use the Excel template that includes the shape placeholder to generate a new document, the ER format

must contain a CELLCELL  element that refers to the Excel shape element. Otherwise, no shape placeholder will appear in

the report's output. If the binding of a CELLCELL  element that refers to the named Excel shape element returns no data at

run time, the document that is generated will show the text of the shape placeholder from the Excel template. To hide

a shape in the document that you're generating, define a CELLCELL  element that refers to the named Excel shape element,

and specify that the EnablingEnabling expression should return a value of FALSEFALSE.

In the Excel template, use a unique name for every element. These elements include shapes and cells. If you duplicate

an element name, the content of the report that is generated will be ambiguous and confusing.

You can reuse the ER format that uses an Excel template to create documents that include embedded images. In the ER

format, make sure that a name is specified for the CELLCELL  element that refers to a named picture element in Excel, and that

is bound to a data source that returns a picture at run time.

First, you must configure the Word document's layout. Use the Picture ContentPicture Content control to create a placeholder

for the embedded image. To access this control, you must first make the DeveloperDeveloper  tab visible on the Word

Ribbon.

Next, delete the Excel template from the ER format, and attach the Word template document. Update the

reference to the template, and save your changes. The structure of the current ER format is saved to the Word

template as a new custom XML part that is named Repor tRepor t.

Next, save the Word template for the current ER format to your local computer. Open the template, and open the

XML MappingXML Mapping pane. Find the custom XML part that is named Repor tRepor t, and then point to the CELLCELL  element in

the ER report that is bound to a data source that returns an image in binary format. Map this XML part's item to

the selected Picture ContentPicture Content control, and save your changes.



More information

DESC RIP T IO NDESC RIP T IO N F IL E  N A M EF IL E  N A M E

ER data model configuration Model for cheques.xml

ER format configuration Cheques printing format.xml

Company logo image Company logo.png

Signature image Signature image.png

Alternative signature image Signature image 2.png

Microsoft Word template for printing payment checks Cheque template Word.docx

Microsoft Excel template for printing payment checks Cheque template.xlsx

Finally, delete the Word template from the ER format, and attach the Word document that includes the mapped

custom XML parts. Update the format reference to the template, and save the changes that you made to this ER

format.

To become familiar with the details of this feature, play the set of task guides, ER Make repor ts in MS OfficeER Make repor ts in MS Office

formats with embedded imagesformats with embedded images . These task guides show how you can embed the images of a company logo

and an authorized person's signature in the payment checks that are generated by using the ER tool in Excel and

Word documents.

The following table lists the files that are required in order to complete the ER Make repor ts in MS OfficeER Make repor ts in MS Office

formats with embedded imagesformats with embedded images  task guides. Download and save the files to your local computer.

The following graphic provides an example of the test printout for a payment check that is generated from the

Excel template.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/embed-images-shapes-01.png
https://go.microsoft.com/fwlink/?linkid=851448
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Verify prerequisites

Add a new ER model configuration

Add a new ER format configuration

To complete the steps in this procedure, first complete the procedure, "ER Create a configuration provider and

mark it as active." This procedure explains how to design Electronic reporting (ER) configurations to generate a

Microsoft Excel or Word document that contains embedded images. In this procedure, you will create the

required ER configurations for the sample company, Litware, Inc. These steps can be completed using the USMF

dataset. This procedure is created for users with the assigned role of system administrator or electronic

reporting developer. Before you begin, download and save the files listed in the Help topic, Embed images and

shapes in documents that you generate by using ER. The files are: Model for cheques.xml, Cheques printing

format.xml, Company logo.png, Signature image.png, Signature image 2.png, and Cheque template Word.docx.

1. Go to Organization administration > Workspaces > Electronic reporting.

2. Make sure that the configuration provider for the sample company, Litware, Inc., is available and marked as

Active. If you don't see this configuration provider, complete the steps in the procedure, "Create a

configuration provider and mark it as active."

3. Click Reporting configurations.

1. Instead of creating a new model, you can load the ER model configuration file (Model for cheques.xml) that

you saved earlier. This file contains the sample data model for payment cheques and the mapping of the data

model to the data components of the Dynamics 365 for Operations application.

2. On the Versions FastTab, click Exchange.

3. Click Load from XML file.

4. Click Browse, and then select Model for cheques.xml.

5. Click OK.

6. The loaded model will be used as a data source of information to generate documents that contain images in

Excel and Word.

1. Instead of creating a new format, you can load the ER format configuration file (Cheques printing format.xml)

that you saved earlier. This file contains the sample layout of the format to print cheques using the pre-

printed form and the mapping of this format to the 'Model for cheques' data model.

2. Click Exchange.

3. Click Load from XML file.

4. Click Browse and select the Cheques printing format.xml file.

5. Click OK.

6. In the tree, expand 'Model for cheques'.

7. In the tree, select 'Model for cheques\Cheques printing format'.

8. The loaded format will be used to generate documents that contain images in Excel and Word.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-make-reports-ms-office-formats-embedded-images-july-2017.md


Configure ER user parameters

Configure Cash & bank management parameters

NOTENOTE

1. On the Action Pane, click Configurations.

2. Click User parameters.

3. Select Yes in the Run settings field.

Turn on the 'Run draft' flag to start the draft version of the selected format instead of the completed one.

4. Click OK.

1. Go to Cash and bank management > Bank accounts > Bank accounts.

2. Use the Quick Filter to filter on the Bank account field with a value of 'USMF OPER'.

3. On the Action Pane, click Set up.

4. Click Check.

5. Expand the Setup section.

6. Click Edit.

7. Select Yes in the Company logo field.

8. Click Company logo.

9. Click Change.

10. Click Browse and select the file that you downloaded earlier, Company logo.png.

11. Click Save.

12. Close the page.

13. Expand the Signature section.

14. Select Yes in the Print first signature field.

15. Click Change.

16. Click Browse and select the file that you downloaded earlier, Signature image.png.

17. Expand the Copies section.

18. In the Watermark field, select an option.

19. Select Yes in the Generic electronic Export format field.

20. Select 'Cheques printing form' configuration.

21. Now the selected ER format will be used for printing cheques.

22. Click Attach.

23. Click New.

24. Click File.

25. Click Browse and select the file that you downloaded earlier, Signature image 2.png.

26. Close the page.

27. Close the page.

28. Close the page.

29. Go to Cash and bank management > Setup > Cash and bank management parameters.

30. Select Yes in the Allow prenote creation on inactive bank accounts: field.

31. Click Save.

32. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Review the imported data model

To complete these steps, you must first complete the steps in the "ER Make reports in MS Office formats with

embedded images (Part 1: Set up parameters)" task guide.

This procedure shows how to design Electronic reporting (ER) configurations to generate electronic documents

that contain embedded images in Microsoft Excel and Microsoft Word. In this example, you will review ER

configurations for the sample company Litware, Inc.

This procedure is intended for users who have the System administrator or Electronic reporting developer role

assigned to them. The steps can be completed by using the USMF data set.

1. Go to Organization administration > Electronic reporting > Configurations.

2. In the tree, select 'Model for cheques'.

3. Click Designer.

4. In the tree, expand 'root'.

5. In the tree, select 'root\cheques'.

6. In the tree, expand 'root\cheques'.

7. In the tree, expand 'root\cheques\attributes'.

8. In the tree, expand 'root\payer'.

9. In the tree, select 'root\istestrun'.

10. In the tree, select 'root\layout'.

11. In the tree, expand 'root\layout'.

12. In the tree, select 'root\layout\company logo'.

13. In the tree, expand 'root\layout\company logo'.

14. In the tree, select 'root\layout\company logo\image'.

15. In the tree, select 'root\layout\company logo\isprinted'.

16. In the tree, select 'root\layout\signature'.

17. In the tree, expand 'root\layout\signature'.

18. In the tree, select 'root\layout\signature\image'.

19. In the tree, select 'root\layout\signature\isprinted'.

20. In the tree, expand 'root\layout\watermark'.

21. Click Map model to datasource.

22. Click Designer.

This model is designed to represent payment cheques from the business standpoint and the mapping

of this model to the application's data sources. Review this model by the ER Operations designer. Note

the attributes of the model elements that are presented: structure, name, description, data type, and so

on.

The layout element of this model represents the details of the printing cheque form layout for the

selected bank account. It also includes two nodes of the Container data type to store images.

Note that two image data model elements are bound to the fields of the tables that contain images of

the company logo and the authorized person's signature in binary format.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-make-reports-ms-office-formats-embedded-images-part-2-review-configurations.md


Review the imported format

23. In the tree, expand 'chequesselected'.

24. In the tree, expand 'layout'.

25. In the tree, expand 'layout\company logo'.

26. In the tree, expand 'layout\signature'.

27. In the tree, expand 'layout\watermark'.

28. Toggle 'Show details' on.

29. Close the page.

30. Close the page.

31. Close the page.

Note that the cheques data model element is bound to the TmpChequePrintout table that, at runtime,

will contain records for cheques that the user has selected for printing.

1. In the tree, expand 'Model for cheques'.

2. In the tree, select 'Model for cheques\Cheques printing format'.

3. Click Designer.

4. Click Attachments.

5. Click Open.

6. Close the page.

7. In the tree, expand 'Report'.

8. In the tree, expand 'Report\ChequeLines'.

9. In the tree, select 'Report\ChequeLines\CompLogo'.

10. Toggle 'Show details' on.

11. Click the Mapping tab.

12. Click Edit enabled.

13. Close the page.

14. In the tree, expand 'labels: Container'.

15. Close the page.

Open the attached report's template in Excel.

Review the attached report's Excel template that will be used to print cheques. The template contains

two cheques per page and is designed to print cheques to the preprinted form. Note that two blank

images are embedded. These blank images are for the company logo and the signature of the person

who is authorizing a payment. Verify that the images are named CompLogo and SignatureImage,

respectively, in Excel.

Note that the 'CompLogo' format's cell element represents the Excel item that is used to populate the

company logo image in the report. This format element is bound to the image data model element

that, at runtime, contains a company logo image in binary format.

Note that you can make the 'CompLogo' format's cell element so that it's no longer enabled. In this

case, the associated Excel image element will hide a company logo in the generated report. If the

enabled expression returns TRUE and the defined binding brings no image, the associated Excel image

element will show an image that has been saved in the Excel template.

Some labels that are presented in the preprinted cheque form will be included in the report when it's

created for testing purposes. However, those labels won't be printed during real printing, because the

preprinted form already includes them.
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Run format with initial model mapping

The following steps explain how a user playing either 'System administrator' or 'Electronic reporting developer'

role can design Electronic reporting (ER) configurations to generate electronic documents in MS office formats

(Excel and Word) containing embedded images.

In this example, you will use created ER configurations for sample company, 'Litware, Inc.'. To complete these

steps, you must first complete the steps in the "ER Make reports in MS Office formats with embedded images

(Part 2: Review configurations)" task guide. These steps can be performed in 'USMF' company.

1. Go to Cash and bank management > Bank accounts > Bank accounts.

2. Use the Quick Filter to filter on the Bank account field with a value of 'USMF OPER'.

3. On the Action Pane, click Set up.

4. Click Check.

5. Click Print test.

6. Select Yes in the Negotiable check format field.

7. Click OK.

8. Expand the Copies section.

9. Click Edit.

10. In the Watermark field, enter 'Print watermark as Void'.

11. Click Print test.

12. Click OK.

13. Close the page.

14. On the Action Pane, click Manage payments.

15. Click Checks.

16. Click Show filters.

17. Apply the following filters: Enter a filter value of "381","385","389" on the "Check number" field using the "is

one of" filter operator.

18. In the list, mark all rows.

19. Click Print check copy.

Run the format for testing purposes.

Review the created output. The company logo is presented in the report as well as the authorized

person's signature. The signature image is taken from the field of the 'Container' data type of the

cheque layout record that is associated with the selected bank account.

Change the watermark layout setting to show the watermark text in generating document in an Excel

shape element.

Review the created output. The watermark is shown in the created report in accordance to the

selection option.

Run the format to reprint the selected cheques.

Review the created output. The selected cheques have been reprinted. The company logo and labels

are not printed out since they are presented on the pre-printed form.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-make-reports-ms-office-formats-embedded-images-part-3-generate-reports.md


Modify the mapping of the imported data model

Run format using the adjusted model mapping

Use MS Word document as a template in the imported format

1. Close the page.

2. Close the page.

3. Go to Organization administration > Electronic reporting > Configurations.

4. In the tree, select 'Model for cheques'.

5. Click Designer.

6. Click Map model to datasource.

7. Click Designer.

8. Turn off Show details.

9. In the tree, expand 'layout'.

10. In the tree, expand 'layout\signature'.

11. In the tree, select 'layout\signature\image =

chequesaccount.'<Relations'.BankChequeLayout.Signature1Bmp'.

12. In the tree, expand 'chequesaccount'.

13. In the tree, expand 'chequesaccount<Relations'.

14. In the tree, expand 'chequesaccount<Relations\BankChequeLayout'.

15. In the tree, expand 'chequesaccount<Relations\BankChequeLayout<Relations'.

16. In the tree, expand 'chequesaccount<Relations\BankChequeLayout<Relations<Documents'.

17. In the tree, select

'chequesaccount<Relations\BankChequeLayout<Relations<Documents\getFileContentAsContainer()'.

18. Click Bind.

19. Click Save.

20. Close the page.

21. Close the page.

22. Close the page.

23. Close the page.

We will change the binding of the data model's signature item to get the signature image from the file

that has been attached to the cheque layout record that is associated with the selected bank account.

1. Go to Cash and bank management > Bank accounts > Bank accounts.

2. Use the Quick Filter to find records. For example, filter on the Bank account field with a value of 'USMF

OPER'.

3. On the Action Pane, click Set up.

4. Click Check.

5. Click Print test.

6. Click OK.

Review the created output. The image from the Document Management attachment is presented as

the signature of an authorized person.

1. Close the page.

2. Close the page.

3. Go to Organization administration > Electronic reporting > Configurations.

4. In the tree, expand 'Model for cheques'.

5. In the tree, select 'Model for cheques\Cheques printing format'.



NOTENOTE

6. Click Designer.

7. Click Attachments.

8. Click Delete.

9. Click Yes.

10. Click New.

11. Click File.

12. Close the page.

13. In the Template field, enter or select a value.

14. Click Save.

15. Close the page.

16. Click Edit.

17. Select Yes in the Run Draft field.

18. Close the page.

19. Go to Cash and bank management > Bank accounts > Bank accounts.

20. Use the Quick Filter to filter on the Bank account field with a value of 'USMF OPER'.

21. Click Check.

22. Click Print test.

23. Click OK.

Click Browse and select the downloaded in advance 'Cheque template Word.docx' file.

Review the created output. The output has been generated as a Word document with embedded

images presenting the company logo, the signature of an authorized person and the selected text of

the watermark.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

The Electronic reporting (ER) tool is used to generate business documents in an electronic format. To generate a

business document, you must create an ER format, and then use the ER designer to define the layout of the

business document and specify the data that should be included in it. You can then run the ER format to

generate the business document.

The ER tool can be used to generate business documents as Microsoft Excel files. You can use an Excel document

as a template for these documents. To define the document layout in the ER designer, you can import the

contents of the Excel document that you want to use as a template into the defined ER format. For more details,

and to practice this scenario, play the task guide ER Design a configuration for generating repor ts inER Design a configuration for generating repor ts in

OPENXML formatOPENXML format (part of the 7.5.4.3 Acquire/Develop IT service/solution components (10677) business

process).

If you edit the Excel document that is used as a template for a business document, new ER functionality lets you

reapply the updated template to the ER format. The ER format is then updated so that it adheres to the updated

template. For more details about this functionality, play the task guide ER Modify a format by reapplying anER Modify a format by reapplying an

Excel templateExcel template (part of the 7.5.5.3 Acquire/Develop IT service/solution components (10683) business process).

In the task guide step where you import an updated template, use the modified template of the Payment Report

Excel file, SampleVendPaymWsReport2, as a template.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/modify-electronic-reporting-format-reapply-excel-template.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Define the dependency of ER configurations from other components

To complete these steps, you must first complete the steps in the task guide, ER Manage model mapping

configurations, and you must have access to Microsoft Dynamics Lifecycle Services (LCS).

This procedure shows how to design an Electronic reporting (ER) configuration and specify its dependency from

other software components, so that you can help guarantee that the configuration is correctly downloaded to a

specific version of Finance and Operations. In this example, you will create required ER configurations for the

sample company Litware, Inc.

This procedure is intended for users who have the System administrator or Electronic reporting developer role

assigned to them. The steps can be performed in any company, because ER configurations are shared among

companies.

1. Go to Organization administration > Electronic reporting > Configurations.

Make sure that the configurations tree contains the 'Sample data model' configuration and

subordinate items. Otherwise, complete the steps in the task guide, ER Manage model mapping

configurations, and then start this guide again.

1. In the tree, expand 'Sample data model'.

2. In the tree, select 'Sample data model\Sample mapping'.

3. Expand the Prerequisites section.

4. Click Edit.

5. Click New.

6. Select Product prerequisite component.

7. Select Microsoft Dynamics 365 for Operations (1611).

We selected the draft version of the 'Sample mapping' model mapping configuration. We will now

define its dependency from other software components. This step is considered a prerequisite for

controlling the download of this configuration's version from an ER repository and any further use of

this version.

Note that the 'Implementations' prerequisites group has been added automatically at this stage. This

group contains the prerequisite component that refers to the data model configuration and has the

Implementation flag turned on. This flag indicates that the 'Sample mapping' mapping configuration

is considered the implementation of the 'Sample data model' data model. This component will force

ER to download the 'Sample mapping' mapping configuration from an ER repository whenever the

'Sample data model' model configuration is downloaded.

A single dependency of the current version of a configuration from a software component can be

specified by using the definition of the component's type, and either the component version or a

range of component versions.

Desired dependencies can be grouped together. When the 'All of' grouping type is selected, the

dependency condition of this group is considered satisfied when each dependency condition from this

group and subordinate group is satisfied. When the 'One of' grouping type is selected, the

dependency condition of this group is considered satisfied when at least one dependency condition

from this group is satisfied.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-define-dependency-er-configurations-from-other-components-july-2017.md


Configure the ER repository

8. In the Version field, type '[7.1.1541.3036,8)'.

9. Click Save.

10. Close the page.

11. Click Change status.

12. Click Complete.

13. Click OK.

14. In the tree, select 'Sample data model\Sample mapping (alternative)'.

15. Click Edit.

16. Click New.

17. Select Product prerequisite component.

18. Select Microsoft Dynamics AX 7.0 RTW.

19. In the Version field, type '[7.0.1265.3015,7.1)'.

20. Click Save.

21. Close the page.

22. Click Change status.

23. Click Complete.

24. Click OK.

[7.1.1541.3036,8)

Dependencies that you enter will be evaluated when this configuration is downloaded from any ER

repository. This configuration version will be downloaded from the ER repository when version 1 of

the 'Sample data model' configuration is either already in place or downloaded in advance. If it's

downloaded in advance, it must be completed in Finance and Operations version 7.1.1541.3036 or

later, but must not exceed major version 8.

[7.0.1265.3015,7.1)

Dependencies will be evaluated when the configuration is downloaded from any ER repository. This

configuration version will be downloaded from the ER repository when version 1 of the 'Sample data

model' configuration is either already in place or downloaded in advance. If it's downloaded in

advance, it must be completed in Microsoft Dynamics 365 for Finance and Operations, Enterprise

edition, the version of which must be 7.0.1265.3015 or later, but must not exceed minor version 1.

1. Close the page.

2. Go to Organization administration > Workspaces > Electronic reporting.

3. In the list, mark the selected row.

4. Click Repositories.

5. Click Show filters.

6. Enter a filter value of "LCS" on the "Type name" field using the "contains" filter operator.

7. Click Add to open the drop dialog.

8. In the Configuration repository type field, enter 'LCS'.

9. Click Create repository.

10. In the Project field, enter or select a value.

11. Click OK.

12. Close the page.

Open the list of ER repositories for the current ER provider, Litware, Inc.

If the LCS repository is already registered for the current ER provider, you can skip the remaining steps

in this sub-task. If the LCS repository isn't already registered, complete the remaining steps.

Select the desired LCS project from the lookup of the 'Project' field.



Upload configurations to LCS

Evaluate ER configuration dependencies

1. Click Reporting configurations.

2. In the tree, select 'Sample data model'.

3. Select the completed version of this configuration.

4. Click Change status.

5. Click Share.

6. Click OK.

7. In the tree, expand 'Sample data model'.

8. In the tree, select 'Sample data model\Sample mapping'.

9. Select the completed version of this configuration.

10. Click Change status.

11. Click Share.

12. Click OK.

13. In the tree, select 'Sample data model\Sample mapping (alternative)'.

14. Select the completed version of this configuration.

15. Click Change status.

16. Click Share.

17. Click OK.

Version 1 of this model configuration has been uploaded to LCS by using the LCS project for the ER

repository that was previously configured.

Version 1.1 of this model mapping configuration has been uploaded to LCS by using the LCS project

for the ER repository that was previously configured.

Version 1.1 of this model mapping configuration has been uploaded to LCS by using the LCS project

for the ER repository that was previously configured.

We will delete created configurations from the system and download them back from the LCS repository.

1. In the tree, select 'Sample data model\Sample mapping'.

2. Click Delete.

3. Click Yes.

4. In the tree, select 'Sample data model\Sample mapping (alternative)'.

5. Click Delete.

6. Click Yes.

7. In the tree, select 'Sample data model\Sample format'.

8. Click Delete.

9. Click Yes.

10. In the tree, select 'Sample data model'.

11. Click Delete.

12. Click Yes.

13. Close the page.

14. Click Repositories.

15. Click Show filters.

16. Enter a filter value of "LCS" on the "Type name" field using the "contains" filter operator.

17. Click Open.

Open the list of ER repositories for the current ER provider, Litware, Inc.



NOTENOTE

18. In the tree, select 'Sample data model'.

19. Click Check prerequisites.

20. Click Import.

21. Click Yes.

22. Close the page.

23. Close the page.

24. Close the page.

25. Go to Organization administration > Electronic reporting > Configurations.

26. In the tree, expand 'Sample data model'.

Note that you can view an evaluation of whether prerequisite conditions have been satisfied for each

version of the ER configurations for the current repository. To view this evaluation, click Check

prerequisites.

Note that the model 'Sample mapping' mapping configuration has been downloaded together with

the selected data model configuration. The two files are downloaded together because 'Sample

mapping' has been defined as implementing the selected data model, and because it's applicable for

the application. The 'Sample mapping (alternative)' configuration hasn't been downloaded because

the condition for the required application version isn't satisfied.

If you sign in to Finance and Operations, register the same provider, access the same LCS project, and

download the same data model configuration, the 'Sample mapping (alternative)' configuration will

download, whereas the 'Sample mapping' configuration will be skipped.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Create a new data model

The following steps explain how either a system administrator or electronic reporting developer can configure

an Electronic reporting (ER) model to use financial dimensions as a data source for ER reports. These steps can

be performed in any company.

To complete these steps, you must first complete the steps in the procedure, "Create a configuration provider

and mark it as active".

1. Go to Organization administration > Workspaces > Electronic reporting.

2. Click Reporting configurations.

3. Click Create configuration to open the drop dialog.

4. In the Name field, type 'Financial dimensions sample model'.

5. Click Create configuration.

6. Click Designer.

7. Click New to open the drop dialog.

8. In the Name field, type 'Entry'.

9. Click Add.

10. Click New to open the drop dialog.

11. In the Name field, type 'Company'.

12. Click Add.

13. Click New to open the drop dialog.

14. In the Name field, type 'Dimensions setting'.

15. In the Item type field, select 'Record list'.

16. Click Add.

17. Click New to open the drop dialog.

18. In the Name field, type 'Code'.

19. In the Item type field, select 'String'.

20. Click Add.

21. Click New to open the drop dialog.

22. In the Name field, type 'Name'.

23. Click Add.

24. In the tree, select 'Entry'.

25. Click New to open the drop dialog.

26. In the Name field, type 'Journal'.

27. In the Item type field, select 'Record list'.

28. Click Add.

Make sure that the "Litware, Inc." provider is available and marked as active.

We will add to our model a new record list. This list will expose (for any ER reports using this model as

data source) the settings of selected financial dimensions. Each financial dimension will be presented

in this list as a record with appropriate fields representing dimension's setting.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-financial-dimensions-data-source-1.md


29. Click New to open the drop dialog.

30. In the Name field, type 'Batch'.

31. In the Item type field, select 'String'.

32. Click Add.

33. Click New to open the drop dialog.

34. In the Name field, type 'Transaction'.

35. In the Item type field, select 'Record list'.

36. Click Add.

37. Click New to open the drop dialog.

38. In the Name field, type 'Date'.

39. In the Item type field, select 'Date'.

40. Click Add.

41. Click New to open the drop dialog.

42. In the Name field, type 'Debit'.

43. In the Item type field, select 'Real'.

44. Click Add.

45. Click New to open the drop dialog.

46. In the Name field, type 'Credit'.

47. Click Add.

48. Click New to open the drop dialog.

49. In the Name field, type 'Currency'.

50. In the Item type field, select 'String'.

51. Click Add.

52. Click New to open the drop dialog.

53. In the Name field, type 'Voucher'.

54. Click Add.

55. Click New to open the drop dialog.

56. In the Name field, type 'Dimensions data'.

57. In the Item type field, select 'Record list'.

58. Click Add.

59. Click New to open the drop dialog.

60. In the Name field, type 'Code'.

61. In the Item type field, select 'String'.

62. Click Add.

63. Click New to open the drop dialog.

64. In the Name field, type 'Description'.

65. Click Add.

66. Click New to open the drop dialog.

67. In the Name field, type 'Name'.

68. Click Add.

69. Click Save.

70. Close the page.

We added to our model a new record list. This list will expose (for any ER reports using this model as

data source) the values of selected financial dimensions. Each financial dimension will be presented in

this list as a record with appropriate fields representing dimension's values. Dimension name will be

also presented in this record as a field to be used, if needed, for selection purposes.



NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Add required data sources to model mapping

The following steps explain how a user assigned to the system administrator or electronic reporting developer

role can configure an Electronic reporting (ER) model to use financial dimensions as a data source for ER

reports. These steps can be performed in any company.

To complete these steps, you must first complete the steps in the "ER Use financial dimensions as a data source

(Part 1: Design data model" procedure.

1. Go to Organization administration > Electronic reporting > Configurations.

2. In the tree, select 'Financial dimensions sample model'.

3. Click Designer.

4. Click Map model to datasource.

5. Click New.

6. In the Definition field, select Entry.

7. In the Name field, type 'Dimensions data mapping'.

8. In the Description field, type 'Dimensions data mapping'.

9. Click Save.

10. Click Designer.

11. In the tree, select 'Dynamics 365 for Operations\Table'.

12. Click Add root.

13. In the Name field, type 'Company'.

14. In the Table field, type 'CompanyInfo'.

15. Click OK.

16. In the tree, select 'Functions\Financial dimensions details'.

17. Click Add root.

18. In the Name field, type a value.

19. Select Yes in the Ask for dimensions field.

20. In the Financial dimensions selection field, select 'Legal entity'.

21. Select Yes in the Ask for main account field.

This data source specifies how the scope of financial dimensions will be defined for any report that

will use this model as a data source.

Select Yes to allow the user to select dimensions at run-time on the User dialog form. If set to No, all

financial dimensions of the current instance will be used by default.

Select All to allow the user to select desire dimensions for the current instance in the Lookup field.

Select Legal entity to allow the user to select dimensions for the company in the Lookup field. Select

Dimension to allow the user to select dimensions using a single dimension set.

Set 'Ask for main account' to Yes to allow users to select the main account as part of the list of

dimensions. If set to No, the main account will not be included to the list of dimensions and the 'Is

main account mandatory' option is enabled. If "Is main account mandatory' is set to Yes, include the

main account in the list of dimensions regardless of the user's selection.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-financial-dimensions-data-source-2.md


Map data model elements to added data sources

22. Click OK. 

23. In the tree, select 'Dynamics 365 for Operations\Table records'.

24. Click Add root.

25. In the Name field, type 'LedgerJournal'.

26. Select Yes in the Ask for query field.

27. In the Table field, type 'LedgerJournalTable'.

28. Click OK. 

1. In the tree, expand 'Journal'.

2. In the tree, expand 'Journal\Transaction'.

3. In the tree, expand 'Journal\Transaction\Dimensions data'.

4. In the tree, expand 'Dimensions setting'.

5. In the tree, expand 'LedgerJournal'.

6. In the tree, expand 'LedgerJournal<Relations'.



7. In the tree, expand 'LedgerJournal<Relations\LedgerJournalTrans'.

8. In the tree, select 'LedgerJournal<Relations\LedgerJournalTrans\Voucher'.

9. In the tree, select 'Journal\Transaction\Voucher'.

10. Click Bind.

11. In the tree, select

'LedgerJournal<Relations\LedgerJournalTrans\Account.Dimension(LedgerDimension.Dimension)'.

12. In the tree, expand

'LedgerJournal<Relations\LedgerJournalTrans\Account.Dimension(LedgerDimension.Dimension)'.

13. In the tree, expand

'LedgerJournal<Relations\LedgerJournalTrans\Account.Dimension(LedgerDimension.Dimension)\Main

account and dimensions'.

14. In the tree, expand

'LedgerJournal<Relations\LedgerJournalTrans\Account.Dimension(LedgerDimension.Dimension)\Main

account and dimensions\Value'.

15. In the tree, expand

'LedgerJournal<Relations\LedgerJournalTrans\Account.Dimension(LedgerDimension.Dimension)\Main

account and dimensions\Definition'.

16. In the tree, select

'LedgerJournal<Relations\LedgerJournalTrans\Account.Dimension(LedgerDimension.Dimension)\Main

account and dimensions\Definition\Name'.

17. In the tree, select 'Journal\Transaction\Dimensions data\Name'.

18. Click Bind.

19. In the tree, select

'LedgerJournal<Relations\LedgerJournalTrans\Account.Dimension(LedgerDimension.Dimension)\Main

account and dimensions\Value\Description'.

20. In the tree, select 'Journal\Transaction\Dimensions data\Description'.

21. Click Bind.

22. In the tree, select

'LedgerJournal<Relations\LedgerJournalTrans\Account.Dimension(LedgerDimension.Dimension)\Main

account and dimensions\Value\Code'.

23. In the tree, select 'Journal\Transaction\Dimensions data\Code'.

24. Click Bind.

25. In the tree, select

'LedgerJournal<Relations\LedgerJournalTrans\Account.Dimension(LedgerDimension.Dimension)\Main

account and dimensions'.

26. In the tree, select 'Journal\Transaction\Dimensions data'.

27. Click Bind. 

Note that for any reference to financial dimensions that is set to, for instance, LedgerDimension, a

corresponding data source item is available (LedgerDimension.Dimension). This data source item

offers the financial dimensions of that dimensions set as the record's list.



28. In the tree, select 'LedgerJournal<Relations\LedgerJournalTrans\Debit(AmountCurDebit)'.

29. In the tree, select 'Journal\Transaction\Debit'.

30. Click Bind.

31. In the tree, select 'LedgerJournal<Relations\LedgerJournalTrans\Date(TransDate)'.

32. In the tree, select 'Journal\Transaction\Date'.

33. Click Bind.

34. In the tree, select 'LedgerJournal<Relations\LedgerJournalTrans\Currency(CurrencyCode)'.

35. In the tree, select 'Journal\Transaction\Currency'.

36. Click Bind.

37. In the tree, select 'LedgerJournal<Relations\LedgerJournalTrans\Credit(AmountCurCredit)'.

38. In the tree, select 'Journal\Transaction\Credit'.

39. Click Bind.

40. In the tree, select 'LedgerJournal<Relations\LedgerJournalTrans'.

41. In the tree, select 'Journal\Transaction'.

42. Click Bind.

43. In the tree, select 'LedgerJournal\Journal batch number(JournalNum)'.

44. In the tree, select 'Journal\Batch'.

45. Click Bind.

46. In the tree, select 'LedgerJournal'.

47. In the tree, select 'Journal'.

48. Click Bind.

49. In the tree, expand 'Dimensions'.

50. In the tree, expand 'Dimensions\Main account and dimensions'.

51. In the tree, expand 'Dimensions\Main account and dimensions\Definition'.

52. In the tree, select 'Dimensions\Main account and dimensions\Definition\Name'.

53. In the tree, select 'Dimensions setting\Code'.

54. Click Bind.

55. In the tree, select 'Dimensions\Main account and dimensions\Definition\Report column name'.

56. In the tree, select 'Dimensions setting\Name'.

57. Click Bind.

58. In the tree, select 'Dimensions\Main account and dimensions'.

59. In the tree, select 'Dimensions setting'.

60. Click Bind.

61. In the tree, select 'Company'.



Complete this draft model's version

62. Click Edit.

63. In the expressionAsStringText field, enter 'Company.'find()'.'name()''.

64. Click Save. 

65. Close the page.

66. Click Save.

67. Close the page.

Company.'find()'.'name()'

1. Close the page.

2. Close the page.

3. Click Change status.

4. Click Complete.

5. Click OK. 



NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Design a report to present financial dimensions

The following steps explain how a user assigned to the system administrator or electronic reporting developer

role can configure an Electronic reporting (ER) model to use financial dimensions as a data source for ER

reports. These steps can be performed in any company.

To complete these steps, you must first complete the steps in the "ER Use financial dimensions as a data source

(Part 2: Model mapping)" procedure.

1. Go to Organization administration > Electronic reporting > Configurations.

2. In the tree, select 'Financial dimensions sample model'.

3. Click Create configuration to open the drop dialog.

4. In the New field, enter 'Format based on data model Financial dimensions sample model'.

5. In the Name field, type 'Ledger journal report'.

6. In the Data model definition field, select Entry.

7. Click Create configuration.

8. Click Designer.

9. Click Add root to open the drop dialog.

10. In the tree, select 'XML\Element'.

11. In the Name field, type 'Root'.

12. Click OK.

13. Click Add to open the drop dialog.

14. In the tree, select 'XML\Attribute'.

15. In the Name field, type 'Company'.

16. Click OK.

17. Click Add to open the drop dialog.

18. In the tree, select 'XML\Element'.

19. In the Name field, type 'Journal'.

20. Click OK.

21. In the tree, select 'Root: XML Element\Journal: XML Element'.

22. Click Add to open the drop dialog.

23. In the tree, select 'XML\Attribute'.

24. In the Name field, type 'Batch'.

25. Click OK.

26. Click Add to open the drop dialog.

27. In the tree, select 'XML\Element'.

28. In the Name field, type 'Transaction'.

29. Click OK.

30. In the tree, select 'Root: XML Element\Journal: XML Element\Transaction: XML Element'.

31. Click Add to open the drop dialog.

Use the model that was created in advance as the data source for your new report.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-financial-dimensions-data-source-3.md


Map report elements to data sources

32. In the tree, select 'XML\Attribute'.

33. In the Name field, type 'Voucher'.

34. Click OK.

35. Click Add Attribute.

36. In the Name field, type 'Date'.

37. Click OK.

38. Click Add Attribute.

39. In the Name field, type 'Currency'.

40. Click OK.

41. Click Add Attribute.

42. In the Name field, type 'Dt'.

43. Click OK.

44. Click Add Attribute.

45. In the Name field, type 'Ct'.

46. Click OK.

47. Click Add to open the drop dialog.

48. In the tree, select 'XML\Element'.

49. In the Name field, type 'Dimensions'.

50. Click OK.

51. In the tree, select 'Root: XML Element\Journal: XML Element\Transaction: XML Element\Dimensions: XML

Element'.

52. Click Add to open the drop dialog.

53. In the tree, select 'XML\Attribute'.

54. In the Name field, type 'Code'.

55. Click OK.

56. Click Add Attribute.

57. In the Name field, type 'Value'.

58. Click OK.

59. Click Add Attribute.

60. In the Name field, type 'Desc'.

61. Click OK. 



1. Click the Mapping tab.

2. In the tree, expand 'model: Data model Financial dimensions sample model'.

3. In the tree, expand 'model: Data model Financial dimensions sample model\Journal: Record list'.

4. In the tree, expand 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list'.

5. In the tree, expand 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list\Dimensions data: Record list'.

6. In the tree, select 'Root: XML Element\Journal: XML Element\Transaction: XML Element\Dimensions: XML

Element\Desc: XML Attribute'.

7. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list\Dimensions data: Record list\Description: String'.

8. Click Bind.

9. In the tree, select 'Root: XML Element\Journal: XML Element\Transaction: XML Element\Dimensions: XML

Element\Value: XML Attribute'.

10. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list\Dimensions data: Record list\Code: String'.

11. Click Bind.

12. In the tree, select 'Root: XML Element\Journal: XML Element\Transaction: XML Element\Dimensions: XML

Element\Code: XML Attribute'.

13. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list\Dimensions data: Record list\Name: String'.

14. Click Bind.

15. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list\Dimensions data: Record list'.

16. In the tree, select 'Root: XML Element\Journal: XML Element\Transaction: XML Element\Dimensions: XML

Element'.

17. Click Bind.

18. In the tree, select 'Root: XML Element\Journal: XML Element\Transaction: XML Element\Ct: XML Attribute'.

19. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list\Credit: Real'.

20. Click Bind.

21. In the tree, select 'Root: XML Element\Journal: XML Element\Transaction: XML Element\Dt: XML Attribute'.

22. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list\Debit: Real'.

23. Click Bind.

24. In the tree, select 'Root: XML Element\Journal: XML Element\Transaction: XML Element\Currency: XML

Attribute'.

25. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list\Currency: String'.

26. Click Bind.

27. In the tree, select 'Root: XML Element\Journal: XML Element\Transaction: XML Element\Date: XML Attribute'.

28. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list\Date: Date'.

29. Click Bind.

30. In the tree, select 'Root: XML Element\Journal: XML Element\Transaction: XML Element\Voucher : XML

Attribute'.

31. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list\Voucher : String'.



NOTENOTE

32. Click Bind.

33. In the tree, select 'Root: XML Element\Journal: XML Element\Transaction: XML Element'.

34. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list'.

35. Click Bind.

36. In the tree, select 'Root: XML Element\Journal: XML Element\Batch: XML Attribute'.

37. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Batch: String'.

38. Click Bind.

39. In the tree, select 'Root: XML Element\Journal: XML Element'.

40. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list'.

41. Click Bind.

42. In the tree, select 'Root: XML Element\Company: XML Attribute'.

43. In the tree, select 'model: Data model Financial dimensions sample model\Company: String'.

44. Click Bind.

45. Click Save.

46. Close the page. 

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Run report

The following steps explain how a user assigned to the system administrator or electronic reporting developer

role can configure an Electronic reporting (ER) model to use financial dimensions as a data source for ER

reports. These steps can be performed in the DEMF company.

To complete these steps, you must first complete the steps in the "ER Use financial dimensions as a data source

(Part 3: Design the report)" procedure. You must also configure default document types on the Electronic

reporting parameters page. Default document types are also set when you download and import any ER

configuration.

1. Go to Organization administration > Electronic reporting > Configurations.

2. In the tree, expand 'Financial dimensions sample model'.

3. In the tree, select 'Financial dimensions sample model\Ledger journal report'.

4. Click Run. 

5. In the Dimension name field, enter or select a value.

To select all dimensions in the current company, enter the following information:

BusinessUnit;CostCenter ;Department;ItemGroup;MainAccount;Project

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-financial-dimensions-data-source-4.md


NOTENOTE

6. Expand the Records to include section.

7. Click Filter.

8. Select the row for the Ledger journal table and the Journal batch number field.

9. In the Criteria field, type '00057'.

10. Click OK.

11. Click OK. 

Review the generated output. For each transaction of the selected batch, the financial dimensions from

the corresponding dimensions set are presented. Run this report and select different dimensions to

see that the report is not dependent on the number of selected dimensions or the number of

dimensions configured for this instance.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Get access to the list of configurations provided by Microsoft

Get the Intrastat configurations provided by Microsoft

NOTENOTE

The following steps explain how a user assigned to the system administrator or electronic reporting developer

role can configure an Electronic reporting (ER) format to do counting and summing based on data of the already

generated text output. These steps can be performed in any company.

To complete these steps, you must first complete the steps in the "Create a configuration provider and mark it as

active" procedure.

This procedure is for a feature that was added in Dynamics 365 for Operations version 1611.

1. Go to Organization administration > Workspaces > Electronic reporting.

2. Select the "Litware, Inc." provider.

3. Click Repositories.

4. Click Add to open the drop dialog.

5. In the Configuration repository type field, enter 'Operations resources'.

6. Click Create repository.

7. Click OK.

Make sure that the "Litware, Inc." provider is available and marked as active.

If a repository of the "Operations resources" type already exists, skip the remaining steps of the

current sub-task.

1. Click Open.

2. In the tree, select 'Intrastat model\Intrastat (DE)'.

3. Click Import.

4. Click Yes.

5. Close the page.

6. Close the page.

7. Click Reporting configurations.

8. In the tree, expand 'Intrastat model'.

9. In the tree, select 'Intrastat model\Intrastat (DE)'.

Click Import for version 1.1 of the selected configuration.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-format-counting-summing-1.md
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ER Configure format to do counting and summing
(Part 2 - Configure computations)
2/18/2021 • 4 minutes to read • Edit Online

Create a format configuration to add counting and summing details

Configure this report to do counting and summation based on output
details

The following steps explain how a user assigned to the system administrator or electronic reporting developer

role can configure an Electronic reporting (ER) format to do counting and summing based on data of the already

generated text output. These steps can be performed in any company.

To complete these steps, you must first complete the steps in the "ER Configure format to do counting and

summing (Part 1: Create format)" procedure.

This procedure is for a feature that was added in Dynamics 365 for Operations version 1611.

1. Go to Organization administration > Workspaces > Electronic reporting.

2. Click Reporting configurations.

3. In the tree, expand 'Intrastat model'.

4. In the tree, select 'Intrastat model\Intrastat (DE)'.

5. Click Create configuration to open the drop dialog.

6. In the New field, enter 'Derive from Name: Intrastat (DE), Microsoft'.

7. In the Name field, type 'Intrastat (DE) with counting & summing'.

8. Click Create configuration.

Assume that you need to customize the format provided by Microsoft by adding lines with summary

details at the end of the Intrastat report. You need to do that by deriving our own instance of the

Intrastat configuration from the Microsoft instance to make modifications.

1. Click Designer.

2. Select Yes in the Collect output details field.

3. Click the Mapping tab.

4. Click Add root to open the drop dialog.

5. In the tree, select 'Data model\Enumeration '.

6. In the Name field, type 'Direction'.

7. In the Model enumeration field, enter or select a value.

8. Click OK.

9. Click Add root to open the drop dialog.

10. In the tree, select 'Functions\Calculated field'.

11. In the Name field, type '$BlockName'.

This flag will activate at run-time the process of collecting output details for generating the Intrastat

file.

You need to do counting for different Intrastat directions, so add a dedicated model enumeration to

the data sources' list of this format configuration.

Select the value Direction.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-format-counting-summing-2.md


12. Click Edit formula.

13. In the Formula field, enter '"block"'.

14. Click Save.

15. Close the page.

16. Click OK.

17. Click Add root to open the drop dialog.

18. In the tree, select 'Functions\Calculated field'.

19. In the Name field, type '$RecName'.

20. Click Edit formula.

21. In the Formula field, enter '"record"'.

22. Click Save.

23. Close the page.

24. Click OK.

25. Click Add root to open the drop dialog.

26. In the tree, select 'Functions\Calculated field'.

27. In the Name field, type '$InvName'.

28. Click Edit formula.

29. In the Formula field, enter '"InvoicedAmountEUR"'.

30. Click Save.

31. Close the page.

32. Click OK.

33. In the tree, select 'Intrastat\Data'.

34. Click Edit button for the 'Collected data key name' field

35. Click Add data source.

36. Click Save.

37. Close the page.

38. Click the Edit button for the Collected data key value field.

39. In the Formula field, enter 'IF(Intrastat.CommodityRecord.Direction=Direction.Import, "Import", "Export")'.

40. Click Save.

41. Close the page.

42. In the tree, expand 'Intrastat\Data: Sequence'.

43. In the tree, select 'Intrastat\Data: Sequence\Arrivals?'.

44. Click Edit button for the 'Collected data key name' field.

45. In the tree, select '$RecName'.

46. Click Add data source.

47. Click Save.

48. Close the page.

49. Click Edit button for the 'Collected data key value' field

50. In the Formula field, enter 'Intrastat.CommodityRecord.CommodityCode'.

$BlockName

IF(Intrastat.CommodityRecord.Direction=Direction.Import, "Import", "Export")

Count the lines of this sequence. The results will be used with the name "block" separately for different

directions. Value "Import" will be used for any arrivals Intrastat transactions. The value "Export" will be

used for any Intrastat dispatches transactions. Consider this to be a virtual Excel spreadsheet. For each

transaction a row where the first column "block" is filled with the values "Import" and "Export"

accordingly.

Count the lines of this sequence. The results will be memorized using the name "record".



51. Click Save.

52. Close the page.

53. In the tree, select 'Intrastat\Data: Sequence\Dispatches?'.

54. Click Edit button for the 'Collected data key name' field

55. In the tree, select '$RecName'.

56. Click Add data source.

57. Click Save.

58. Close the page.

59. Click the Edit button for the 'Collected data key value' field.

60. In the Formula field, enter 'Intrastat.CommodityRecord.CommodityCode'.

61. Click Save.

62. Close the page.

63. In the tree, expand 'Intrastat\Data: Sequence\Dispatches: Sequence?'.

64. In the tree, expand 'Intrastat\Data: Sequence\Dispatches: Sequence?\Record = Intrastat.CommodityRecord'.

65. Click the Format tab.

66. In the tree, select 'Intrastat\Data\Dispatches\Record\Invoice amount EUR'.

67. Click the Mapping tab.

68. Click the Edit button for the 'Collected data key name' field.

69. In the tree, select '$InvName'.

70. Click Add data source.

71. Click Save.

72. Close the page.

73. In the tree, expand 'Intrastat\Data\Arrivals?'.

74. In the tree, expand 'Intrastat\Data\Arrivals?\Record = Intrastat.CommodityRecord'.

75. Click the Format tab.

76. In the tree, select 'Intrastat\Data\Arrivals\Record\Invoice amount EUR'.

77. Click the Mapping tab.

78. Click the Edit button for the 'Collected data key name' field.

79. In the tree, select '$InvName'.

80. Click Add data source.

81. Click Save.

82. Close the page.

83. Click Save.

84. Close the page.

Count the lines of this sequence. The results will be used with the name "record" separately for

different commodity codes. Consider this to be a virtual Excel spreadsheet. For each transaction a row

where the first column "block" is filled with the values "Import" and "Export" accordingly and the

second block "record" is filled with the commodity code value.

Summarize the invoiced amount values for lines of this sequence. The results will be used with the

name "InvoicedAmountEUR" separately for different Intrastat directions and commodity codes.

Consider this to be a virtual creation in Excel spreadsheet. For each transaction a row where the first

column "block" is filled with the values "Import" and "Export" accordingly. The second block "record" is

filled with the commodity code value, and the third column "InvoicedAmountEUR" is filled with the

invoice amount value.
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Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Configure this report to use counting and summing info

The following steps explain how a user assigned to the system administrator or electronic reporting developer

role can configure an Electronic reporting (ER) format to do counting and summing based on data of the already

generated text output. These steps can be performed in any company.

To complete these steps, you must first complete the steps in the "ER Configure format to do counting and

summing (Part 2: Configure computations)" procedure.

This procedure is for a feature that was added in Dynamics 365 for Operations version 1611.

1. Go to Organization administration > Workspaces > Electronic reporting.

2. Click Reporting configurations.

3. In the tree, expand 'Intrastat model'.

4. In the tree, expand 'Intrastat model\Intrastat (DE)'.

5. In the tree, select 'Intrastat model\Intrastat (DE)\Intrastat (DE) with counting & summing'.

6. Click Designer.

7. Click the Mapping tab.

8. Click Add root to open the drop dialog.

9. In the tree, select 'Functions\Calculated field'.

10. In the Name field, type '$BlocksList'.

11. Click Edit formula.

12. In the tree, select 'Data collection functions\COLLECTEDLIST'.

13. Click Add function.

14. Click Add data source.

15. In the Formula field, enter 'COLLECTEDLIST('$BlockName', '.

16. In the Formula field, enter 'COLLECTEDLIST('$BlockName', "*")'.

17. Click Save.

18. Close the page.

19. Click OK.

20. Click the Format tab.

21. In the tree, select 'Intrastat\Data'.

22. Click Add to open the drop dialog.

23. In the tree, select 'Text\Sequence'.

24. In the Name field, type 'Totals by blocks'.

Add a new data source to get the list of memorized blocks.

$BlocksList

COLLECTEDLIST('$BlockName',

COLLECTEDLIST('$BlockName', "*")

The pattern "*" means that all blocks will be included to the list for this record.

Totals by blocks

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-format-counting-summing-3.md


25. In the Special characters field, select 'New line - Windows (CR LF)'.

26. Click OK.

27. In the tree, select 'Intrastat\Data\Totals by blocks'.

28. Click Add to open the drop dialog.

29. In the tree, select 'Text\String'.

30. In the Name field, type 'Block code'.

31. Click OK.

32. Click Add String.

33. In the Name field, type 'Lines counting'.

34. Click OK.

35. Click Add String.

36. In the Name field, type 'Total amount'.

37. Click OK.

38. Click the Mapping tab.

39. In the tree, select '$BlocksList'.

40. Click Bind.

41. Click the Format tab.

42. In the tree, select 'Intrastat\Data\Totals by blocks\Block code'.

43. Click the Mapping tab.

44. Click Edit formula.

45. In the Formula field, enter '"Block id: " & '.

46. In the tree, expand '$BlocksList'.

47. In the tree, select '$BlocksList\Value'.

48. Click Add data source.

49. Click Save.

50. Close the page.

51. Click the Format tab.

52. In the tree, select 'Intrastat\Data\Totals by blocks\Lines counting'.

53. Click the Mapping tab.

54. Click Edit formula.

55. In the Formula field, enter '"Number of lines in this block: " & '.

56. In the Formula field, enter '"Number of lines in this block: " & TEXT('.

57. In the tree, select 'Data collection functions\COUNTIFS'.

58. Click Add function.

59. Click Add data source.

60. In the Formula field, enter '"Number of lines in this block: " & TEXT(COUNTIFS('$BlockName', '.

61. In the tree, expand '$BlocksList'.

Block code

Lines counting

Total amount

Create a summary line for each memorized block.

"Block id: " &

Create output for the number of lines for each block presented in this report.

"Number of lines in this block: " &

"Number of lines in this block: " & TEXT(

"Number of lines in this block: " & TEXT(COUNTIFS('$BlockName',
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62. In the tree, select '$BlocksList\Value'.

63. Click Add data source.

64. In the Formula field, enter '"Number of lines in this block: " & TEXT(COUNTIFS('$BlockName',

'$BlocksList'.Value, '.

65. In the tree, select '$RecName'.

66. Click Add data source.

67. In the Formula field, enter '"Number of lines in this block: " & TEXT(COUNTIFS('$BlockName',

'$BlocksList'.Value, '$RecName', "*"))'.

68. Click Save.

69. Close the page.

70. Click the Format tab.

71. In the tree, select 'Intrastat\Data\Totals by blocks\Total amount'.

72. Click the Mapping tab.

73. Click Edit formula.

74. In the Formula field, enter '"Sum of invoiced amount: " & TEXT(SUMIFS('$InvName', '$BlockName',

'$BlocksList'.Value, '$RecName', "*"))'.

75. Click Save.

76. Close the page.

77. Click Save.

78. Close the page.

"Number of lines in this block: " & TEXT(COUNTIFS('$BlockName', '$BlocksList'.Value,

"Number of lines in this block: " & TEXT(COUNTIFS('$BlockName', '$BlocksList'.Value, '$RecName',

"*"))

Create output that will be the total of the invoiced amount for each block presented in this report.

"Sum of invoiced amount: " & TEXT(SUMIFS('$InvName', '$BlockName', '$BlocksList'.Value,

'$RecName', "*"))

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Test this configuration for generation of the Intrastat reports

The following steps explain how a user assigned to the system administrator or electronic reporting developer

role can configure an Electronic reporting (ER) format to do counting and summing based on data of the already

generated text output. These steps can be performed in the DEMF company.

To complete these steps, you must first complete the steps in the "ER Configure format to do counting and

summing (Part 3: Use computations to make the output)" procedure.

This procedure is for a feature that was added in Dynamics 365 for Operations version 1611.

1. Go to Organization administration > Workspaces > Electronic reporting.

2. Click Reporting configurations.

3. In the tree, expand 'Intrastat model'.

4. In the tree, expand 'Intrastat model\Intrastat (DE)'.

5. In the tree, select 'Intrastat model\Intrastat (DE)\Intrastat (DE) with counting & summing'.

6. On the Action Pane, click Configurations.

7. Click User parameters.

8. Select Yes in the Run settings field.

9. Click OK.

10. Click Edit.

11. Select Yes in the Run Draft field.

12. Click Save.

13. Go to Tax > Setup > Foreign trade > Foreign trade parameters.

14. Expand the Electronic reporting section.

15. Select the "Intrastat (DE) with counting & summing" configuration.

16. Select the "Intrastat (DE) with counting & summing" configuration.

17. Click Save.

18. Close the page.

19. Go to Tax > Declarations > Foreign trade > Intrastat.

20. Click Output.

21. Click Report.

22. In the From date field, set the date to '2000-01-01'.

23. In the To date field, set the date to '2022-12-31'.

24. In the Direction field, select 'Arrivals'.

25. Select Yes in the Generate file field.

26. Click OK.

Run the Intrastat report generation process.

Define start and end dates for the reporting period that include the existing on the form transactions.

Define start and end dates for the reporting period that include the existing on the form transactions.

Review the created output with the summary lines in the end.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-format-counting-summing-4.md


Run this configuration in debug mode to review the collected
counting & summing data

NOTENOTE

27. Click New.

28. In the list, mark the selected row.

29. In the Direction field, select 'Dispatches'.

30. In the Item number field, enter or select a value.

31. In the Commodity field, enter or select a value.

32. Set Weight to '10'.

33. Set Invoice amount to '10000'.

34. Set Statistical amount to '10000'.

35. Click Output.

36. Click Report.

37. In the Direction field, select 'Dispatches'.

38. Click OK.

Review the created output with the summary lines in the end. Note that it has been changed in

comparison to the first run.

1. Go to Organization administration > Electronic reporting > Configurations.

2. In the tree, expand 'Intrastat model'.

3. In the tree, expand 'Intrastat model\Intrastat (DE)'.

4. In the tree, select 'Intrastat model\Intrastat (DE)\Intrastat (DE) with counting & summing'.

5. On the Action Pane, click Configurations.

6. Click User parameters.

7. Select Yes in the Run in debug mode field.

8. Click OK.

9. Close the page.

10. Go to Tax > Declarations > Foreign trade > Intrastat.

11. Click Output.

12. Click Report.

13. Click OK.

14. Close the page.

15. Go to Organization administration > Electronic reporting > Configurations.

16. In the tree, expand 'Intrastat model'.

17. In the tree, expand 'Intrastat model\Intrastat (DE)'.

18. In the tree, select 'Intrastat model\Intrastat (DE)\Intrastat (DE) with counting & summing'.

19. Click Debug logs.

20. Click Attach.

21. Click Open.

Note that a debug log record has been created for the execution process of the selected configuration.

Review the created XML file that contains counting and summing details that were collected during

the execution of the selected configuration.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


ER Use horizontally expandable ranges to
dynamically add columns in Excel reports (Part 1 -
Design format)
2/18/2021 • 5 minutes to read • Edit Online

Create a new report configuration

Design the report format

The following steps explain how a user assigned to the system administrator or electronic reporting developer

role can configure an Electronic reporting (ER) format to generate reports as OPENXML worksheets (Excel) files

in which the required columns can be created dynamically as horizontally expandable ranges. These steps can

be performed in any company.

To complete these steps, you must first complete these three task guides:

"ER Create a configuration provider and mark it as active"

"ER Use financial dimensions as a data source (Part 1: Design data model)"

"ER Use financial dimensions as a data source (Part 2: Model mapping)"

You must also download and save a local copy of the template with a sample report found here, Sample

Financial Dimensions Web Service Report.

This procedure is for a feature that was added in Dynamics 365 for Operations version 1611.

1. Go to Organization administration > Electronic reporting > Configurations.

2. In the tree, select 'Financial dimensions sample model'.

3. Click Create configuration to open the drop dialog.

4. In the New field, enter 'Format based on data model Financial dimensions sample model'.

5. In the Name field, type 'Sample report with horizontally expandable ranges'.

6. In the Description field, type 'To make Excel output with dynamically adding columns'.

7. In the Data model definition field, select Entry.

8. Click Create configuration.

Use the model created in advance as the data source for your new report.

Sample report with horizontally expandable ranges

To make Excel output with dynamically adding columns

1. Click Designer.

2. Turn on the 'Show details' toggle button.

3. On the Action Pane, click Import.

4. Click Import from Excel.

5. Click Attachments.

6. Click New.

7. Click File.

8. Close the page.

Import the report's template. Use Excel file that you downloaded for that.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-horizontal-1.md
https://go.microsoft.com/fwlink/?linkid=862266


Map format elements to data sources

9. In the Template field, enter or select a value.

10. Click OK.

11. Click Add to open the drop dialog.

12. In the tree, select 'Excel\Range'.

13. In the Excel range field, type 'DimNames'.

14. In the Replication direction field, select 'Horizontal'.

15. Click OK.

16. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Horizontal'.

17. Click Move up.

18. In the tree, select 'Excel = "SampleFinDimWsReport"\Cell'.

19. Click Cut.

20. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Horizontal'.

21. Click Paste.

22. In the tree, expand 'Excel = "SampleFinDimWsReport"\Range: Horizontal'.

23. In the tree, expand 'Excel = "SampleFinDimWsReport"\Range: Vertical'.

24. In the tree, expand 'Excel = "SampleFinDimWsReport"\Range: Vertical\Range: Vertical'.

25. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Vertical\Range: Vertical'.

26. Click Add Range.

27. In the Excel range field, type 'DimValues'.

28. In the Replication direction field, select 'Horizontal'.

29. Click OK.

30. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Vertical\Range: Vertical\Cell'.

31. Click Cut.

32. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Vertical\Range: Vertical\Range: Horizontal'.

33. Click Paste.

34. In the tree, expand 'Excel = "SampleFinDimWsReport"\Range: Vertical\Range: Vertical\Range: Horizontal'.

Select the downloaded template.

Add a new range to dynamically create Excel output with as many columns as you selected (in the user

dialog form) for financial dimensions. Each cell for every column will represent a single financial

dimension's name.

DimNames

Add a new range to dynamically create Excel output with as many columns as you selected (in the user

dialog form) for financial dimensions. Each cell for every column will represent a single financial

dimension's value for each reporting transaction.

DimValues

1. Click the Mapping tab.

2. In the tree, expand 'model: Data model Financial dimensions sample model'.

3. In the tree, expand 'model: Data model Financial dimensions sample model\Journal: Record list'.

4. In the tree, expand 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list'.

5. In the tree, expand 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list\Dimensions data: Record list'.

6. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Vertical\Range: Vertical\Range: Horizontal\Cell'.

7. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:



Record list\Dimensions data: Record list\Code: String'.

8. Click Bind.

9. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Vertical\Range: Vertical\Range: Horizontal'.

10. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list\Dimensions data: Record list'.

11. Click Bind.

12. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Vertical\Range: Vertical\Cell'.

13. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list\Credit: Real'.

14. Click Bind.

15. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Vertical\Range: Vertical\Cell'.

16. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list\Debit: Real'.

17. Click Bind.

18. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Vertical\Range: Vertical\Cell'.

19. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list\Currency: String'.

20. Click Bind.

21. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Vertical\Range: Vertical\Cell'.

22. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list\Date: Date'.

23. Click Bind.

24. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Vertical\Range: Vertical\Cell'.

25. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list\Voucher : String'.

26. Click Bind.

27. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Vertical\Range: Vertical\Cell'.

28. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Batch: String'.

29. Click Bind.

30. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Vertical\Range: Vertical'.

31. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Transaction:

Record list'.

32. Click Bind.

33. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Vertical\Cell'.

34. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list\Batch: String'.

35. Click Bind.

36. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Vertical'.

37. In the tree, select 'model: Data model Financial dimensions sample model\Journal: Record list'.

38. Click Bind.

39. In the tree, expand 'model: Data model Financial dimensions sample model\Dimensions setting: Record list'.

40. In the tree, select 'model: Data model Financial dimensions sample model\Dimensions setting: Record

list\Code: String'.

41. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Horizontal\Cell'.

42. Click Bind.

43. In the tree, select 'model: Data model Financial dimensions sample model\Dimensions setting: Record list'.

44. In the tree, select 'Excel = "SampleFinDimWsReport"\Range: Horizontal'.

45. Click Bind.



NOTENOTE

46. In the tree, select 'Excel = "SampleFinDimWsReport"\Cell'.

47. In the tree, select 'model: Data model Financial dimensions sample model\Company: String'.

48. Click Bind.

49. Click Save.

50. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Find created format

Execute format to create Excel output

NOTENOTE

The following steps explain how a user assigned to the system administrator or electronic reporting developer

role can configure an Electronic reporting (ER) format to generate reports as OPENXML worksheets (Excel) files

in which the required columns can be created dynamically as horizontally expandable ranges. These steps can

be performed in the DEMF company.

To complete these steps, you must first complete the steps in the "ER Use horizontally expandable ranges to

dynamically add columns in Excel reports (Part 1: Design format)" procedure.

This procedure is for a feature that was added in Dynamics 365 for Operations version 1611.

1. Go to Organization administration > Electronic reporting > Configurations.

2. In the tree, expand 'Financial dimensions sample model'.

3. In the tree, select 'Financial dimensions sample model\Sample report with horizontally expandable ranges'.

1. Click Run.

2. In the Dimension name field, type 'BusinessUnit;CostCenter ;Department'.

3. Expand the Records to include section.

4. Click Filter.

5. Select the row for the Ledger journal table and the Journal batch number field.

6. In the Criteria field, type '00057..00058'.

7. Click OK.

8. Click OK.

In the Dimension name field, enter or select a value. To select all dimensions for the current company,

enter the following: BusinessUnit;CostCenter ;Department;ItemGroup;MainAccount;Project

00057..00058

Review the generated output. Note that the newly created Excel file contains the same number of

columns that were selected for financial dimensions. The report header in those columns represents

financial dimensions' names. The transactions' lines in those columns represent financial dimensions.

Run this report and select different dimensions to see that the report is not dependent on the number

of selected dimensions or the number of dimensions configured for this instance.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Get access to the list of configurations provided by Microsoft

Get the Customer invoice model configurations provided by Microsoft

The following steps explain how a user assigned to the system administrator or electronic reporting developer

role can configure an Electronic reporting (ER) format to use Document Management files (attachments) in ER

output. These steps can be performed in any company.

To complete these steps, you must first complete the steps in the "Create a configuration provider and mark it as

active" procedure.

This procedure is for a feature that was added in Dynamics 365 for Operations version 1611.

1. Go to Organization administration > Workspaces > Electronic reporting.

Make sure that the 'Litware, Inc.' provider is available and marked as active.

2. Select the 'Litware, Inc.' provider.

3. Click Repositories.

If a repository of the 'Operations resources' type already exists, skip the remaining steps of the current

sub-task.

4. Click Add to open the drop dialog.

5. In the Configuration repository type field, enter 'Operations resources'.

6. Click Create repository.

7. Click OK.

1. Click Show filters.

2. Apply the following filters: Enter a filter value of "Operations resources" on the "Name" field using the

"begins with" filter operator ; Enter a filter value of "" on the "Description" field using the "begins with"

filter operator

3. Click Show filters.

4. Click Open.

5. In the tree, select 'Customer invoice model'.

Select the model configuration 'Customer invoice model' to import it.

6. Click Import.

Click Import for version 1 of the selected configuration.

7. Click Yes.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-document-management-files-1.md
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Management files.
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8. Close the page.

9. Close the page.

10. Click Reporting configurations.

11. In the tree, select 'Customer invoice model'.

You will create our own configuration of the Customer invoice model deriving it from the configuration

provided by Microsoft. You will use this configuration to implement access to the Document Management files

and make them available for electronic documents that you will create based on this model.

1. Click Create configuration to open the drop dialog.

2. In the New field, enter 'Derive from Name: Customer invoice model, Microsoft'.

3. In the Name field, type 'Customer invoice model (custom)'.

4. Click Create configuration.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Extend data model to present the Document Management files in it

Map new data model elements to data sources

The following steps explain how a user assigned to the System Administrator or Electronic Reporting Developer

role can configure an Electronic reporting (ER) format to use Document Management files (attachments) in ER

output. These steps can be performed in any company.

To complete these steps, you must first complete the steps in the "ER Use Document Management files in format

outputs (Part 1: Prepare data model)" task guide.

This procedure is for a feature that was added in Dynamics 365 for Operations version 1611.

1. Go to Organization administration > Workspaces > Electronic reporting.

2. Click Reporting configurations.

3. In the tree, expand 'Customer invoice model'.

4. In the tree, select 'Customer invoice model\Customer invoice model (custom)'.

5. Click Designer.

6. In the tree, select 'Customer invoice(InvoiceCustomer)'.

7. Click New to open the drop dialog.

8. In the Name field, type 'Invoice attachments'.

9. In the Item type field, select 'Record list'.

10. Click Add.

11. Click New to open the drop dialog.

12. In the Name field, type 'File content'.

13. In the Item type field, select 'Container'.

14. Click Add.

15. Click New to open the drop dialog.

16. In the Name field, type 'File name'.

17. In the Item type field, select 'String'.

18. Click Add.

We will extend this data model to expose in it any files that have been attached to a sales order that is

related to an electronically processing invoice.

Invoice attachments

File content

File name

1. Click Map model to datasource.

2. Use the Quick Filter to filter on the Definition field with a value of 'InvoiceCustomer'.

3. Click Designer.

InvoiceCustomer

We will map new model elements to appropriate data sources.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-document-management-files-2.md
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4. In the tree, select 'Invoice attachments'.

5. In the tree, expand 'Invoice attachments'.

6. In the tree, select 'Invoice attachments\File name'.

7. Click Edit.

8. In the Formula field, enter

'CustInvoiceJour.'>Relations'.SalesTable.'<Relations'.'<Documents'.'originalFileName()''.

9. Click Save.

10. Close the page.

11. In the tree, select 'Invoice attachments\File content'.

12. Click Edit.

13. In the Formula field, enter

'CustInvoiceJour.'>Relations'.SalesTable.'<Relations'.'<Documents'.'getFileContentAsContainer()''.

14. Click Save.

15. Close the page.

16. In the tree, select 'Invoice attachments'.

17. Click Edit.

18. In the Formula field, enter 'CustInvoiceJour.'>Relations'.SalesTable.'<Relations'.'<Documents''.

19. Click Save.

20. Close the page.

21. Click Save.

22. Close the page.

23. Close the page.

24. Close the page.

25. Click Change status.

26. Click Complete.

27. Click OK.

CustInvoiceJour.'>Relations'.SalesTable.'<Relations'.'<Documents'.'originalFileName()'

CustInvoiceJour.'>Relations'.SalesTable.'<Relations'.'<Documents'.'getFileContentAsContainer()'

CustInvoiceJour.'>Relations'.SalesTable.'<Relations'.'<Documents'

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Create a format to process invoices

Design a format to populate attachments into generating a message
in MIME format

The following steps explain how a user assigned to the system administrator or electronic reporting developer

role can configure an Electronic reporting (ER) format to use Document Management files (attachments) in ER

output. These steps can be performed in any company.

To complete these steps, you must first complete the steps in the "ER Use Document Management files in format

outputs (Part 2: Extend data model" procedure.

This procedure is for a feature that was added in Dynamics 365 for Operations version 1611.

1. Go to Organization administration > Workspaces > Electronic reporting.

2. Click Reporting configurations.

3. In the tree, expand 'Customer invoice model'.

4. In the tree, select 'Customer invoice model\Customer invoice model (custom)'.

5. Click Create configuration to open the drop dialog.

6. In the New field, enter 'Format based on data model Customer invoice model (custom)'.

7. In the Name field, type 'Electronic invoice sample message'.

8. In the Data model definition field, enter or select a value.

9. Click Create configuration.

You will create a format to generate electronic messages with information about any files that have

been attached to a sales order that is related to an electronically processing invoice.

Electronic invoice sample message

InvoiceCustomer

1. Click Designer.

2. Click Add root to open the drop dialog.

3. In the tree, select 'XML\Element'.

4. In the Name field, type 'Invoice'.

5. Click OK.

6. Click Add to open the drop dialog.

7. In the tree, select 'XML\Attribute'.

8. In the Name field, type 'SalesOrder'.

9. Click OK.

10. Click Add Attribute.

11. In the Name field, type 'InvoiceNumber'.

Invoice

SalesOrder

InvoiceNumber

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-document-management-files-3.md
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12. Click OK.

13. Click Add Attribute.

14. In the Name field, type 'InvoiceAmount'.

15. Click OK.

16. Click Add to open the drop dialog.

17. In the tree, select 'XML\Element'.

18. In the Name field, type 'EnclosedDocs'.

19. Click OK.

20. In the tree, select 'Invoice\EnclosedDocs'.

21. Click Add Element.

22. In the Name field, type 'Document'.

23. Click OK.

24. In the tree, select 'Invoice\EnclosedDocs\Document'.

25. Click Add to open the drop dialog.

26. In the tree, select 'XML\Attribute'.

27. In the Name field, type 'FileName'.

28. Click OK.

29. Click Add to open the drop dialog.

30. In the tree, select 'XML\Element'.

31. In the Name field, type 'FileContent'.

32. Click OK.

33. In the tree, select 'Invoice\EnclosedDocs\Document\FileContent'.

34. Click Add to open the drop dialog.

35. In the tree, select 'Text\Base64'.

36. Click OK.

InvoiceAmount

EnclosedDocs

Document

FileName

FileContent

1. In the tree, select 'Invoice\SalesOrder'.

2. Click the Mapping tab.

3. In the tree, expand 'model'.

4. In the tree, select 'model\Sales order number(SalesId)'.

5. Click Bind.

6. In the tree, select 'Invoice\InvoiceNumber'.

7. In the tree, expand 'model\Base invoice(InvoiceBase)'.

8. In the tree, select 'model\Base invoice(InvoiceBase)\Invoice number(Id)'.

9. Click Bind.

10. In the tree, select 'Invoice\InvoiceAmount'.

11. In the tree, select 'model\Base invoice(InvoiceBase)\Invoice amount(Amount)'.

12. Click Bind.

13. In the tree, expand 'model\Invoice attachments'.

14. In the tree, select 'model\Invoice attachments\File content'.
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15. In the tree, select 'Invoice\EnclosedDocs\Document\FileContent\Base64'.

16. Click Bind.

17. In the tree, select 'model\Invoice attachments\File name'.

18. In the tree, select 'Invoice\EnclosedDocs\Document\FileName'.

19. Click Bind.

20. In the tree, select 'model\Invoice attachments'.

21. In the tree, select 'Invoice\EnclosedDocs\Document'.

22. Click Bind.

23. Click Save.

24. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Add necessary attachments for sales order of a single invoice

Run the designed report for the selected invoice

The following steps explain how a user assigned to the system administrator or electronic reporting developer

role can configure an Electronic reporting (ER) format to use Document Management files (attachments) in ER

output. These steps can be performed in the DEMF company.

To complete these steps, you must first complete the steps in the "ER Use Document Management files in format

outputs (Part 3: Create format)" procedure.

This procedure is for a feature that was added in Dynamics 365 for Operations version 1611.

1. Go to Accounts receivable > Invoices > Open customer invoices.

2. Use the Quick Filter to find records. For example, filter on the Invoice field with a value of 'CIV-000148'.

3. Click to follow the selected invoice's link.

4. Click to follow the link in the Sales order field.

5. In the Lines or header field, select the option of Header.

6. Click Attach.

7. Click New.

8. Click File.

9. Click New.

10. Click File.

11. Close the page.

12. Close the page.

13. Close the page.

14. Close the page.

CIV-000148

CIV-000148

000148

Select Header to indicate that this will be the target for adding attachments.

Add a few files as attachments for this sales order. Use the files of the document types that are

supported by the Document Management (with file extensions DOCX, DPF, XML, JPG, etc.). Browse and

select files to be attached and further processed with the related invoice in the ER electronic message.

1. Go to Organization administration > Electronic reporting > Configurations.

2. In the tree, expand 'Customer invoice model'.

3. In the tree, expand 'Customer invoice model\Customer invoice model (custom)'.

4. In the tree, select 'Customer invoice model\Customer invoice model (custom)\Electronic invoice sample

message'.

5. Click Run.

6. Expand the Records to include () section.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-document-management-files-4.md
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7. Click Filter.

8. Select the row of the Customer invoice journal and the Sales order field.

9. In the Criteria field, type '000148'.

10. Click OK.

11. Click OK.

In the criteria "Sales order" field, type the order number 000148.

Review the generated output. Note that for each attachment a single XML node has been created. The

attachment's content is populated to the XML output in MIME (base64) text format.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Modify the format to populate attachments into generating messages
in binary format

The following steps explain how a user assigned to the system administrator or electronic reporting developer

role can configure an Electronic reporting (ER) format to use Document Management files (attachments) in ER

output. These steps can be performed in the DEMF company.

To complete these steps, you must first complete the steps in the "ER Use Document Management files in format

outputs (Part 4: Run format)" procedure.

This procedure is for a feature that was added in Dynamics 365 for Operations version 1611.

1. Go to Organization administration > Electronic reporting > Configurations.

2. In the tree, expand 'Customer invoice model'.

3. In the tree, expand 'Customer invoice model\Customer invoice model (custom)'.

4. In the tree, select 'Customer invoice model\Customer invoice model (custom)\Electronic invoice sample

message'.

5. Click Designer.

6. Click Add root to open the drop dialog.

7. In the tree, select 'Common\File'.

8. In the Name field, type 'Xml message'.

9. In the Encoding field, type 'UTF-8'.

10. Click OK.

11. Click Add root to open the drop dialog.

12. In the tree, select 'Common\Folder'.

13. In the Name field, type 'Zip output'.

14. Click OK.

15. In the tree, select 'Zip output'.

16. Click Add to open the drop dialog.

17. In the tree, select 'Common\File'.

18. In the Name field, type 'Attached file'.

19. Click OK.

20. In the tree, select 'Zip output\Attached file'.

You will populate the invoice message in the generating output as an XML file using UNICODE

encoding.

Xml message

UTF-8

Configure the generating output as a zipped file.

Zip output

Add attachments to the generating zipped file as files with original names and extensions.

Attached file

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-document-management-files-5.md
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21. Click Add to open the drop dialog.

22. In the tree, select 'Text\Base64'.

23. Click OK.

1. Click the Mapping tab.

2. In the tree, expand 'model'.

3. In the tree, expand 'model\Invoice attachments'.

4. In the tree, select 'Zip output\Attached file\Base64'.

5. In the tree, select 'model\Invoice attachments\File content'.

6. Click Bind.

7. In the tree, select 'Zip output\Attached file'.

8. Click Edit filename.

9. In the tree, expand 'model'.

10. In the tree, expand 'model\Invoice attachments'.

11. In the tree, select 'model\Invoice attachments\File name'.

12. Click Add data source.

13. Click Save.

14. Close the page.

15. In the tree, select 'model\Invoice attachments'.

16. Click Bind.

17. Click Save.

18. Close the page.

1. Click Run.

2. Expand the Records to include () section.

3. Click Filter.

4. Select the row of the Customer invoice journal and the Sales order field.

5. In the Criteria field, In the criteria "Sales order" field, type the order number 000148.

6. Click OK.

7. Click OK.

000148

Review the generated output. Note,that in addition to the invoice message in XML format, a single file

has been created for each attachment. The attachment files are populated with the zipped output in

binary format.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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You can design Electronic reporting (ER) formats that can be used in the application to generate outgoing

electronic documents. You can also design ER formats that parse incoming electronic documents and use the

content in those documents to update application data.

With this functionality, a single ER format can be used to generate outgoing electronic documents and then

update the application data. This feature can be used in the following scenarios:

To prevent repeated usage of application data in subsequent processes you can mark an application’s data

immediately after it is used to generate electronic documents. For example, you can mark payment

transactions as already processed immediately after they have been included in a generated payment

message.

To store the processing details of electronic documents that have been generated using ER logic. For

example, a unique payment message identification that is generated using the ER expression. The expression

is based on information entered in the ER dialog box when the ER format is run to generate documents.

To learn more about this feature, play the set of ER Generate documents with application data update Task

guides (part of the 7.5.4.3 Acquire/Develop IT service/solution components (10677) business process), which

walk you through the details of Intrastat reporting and archiving. The following files are required to complete

certain steps in these Task guides. Download and save these files to your local machine.

ER data model configuration: Intrastat (model)

ER model mapping configuration: Intrastat (mapping)

ER format configuration: Intrastat (format)

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Import ER configurations

To complete the steps in this procedure, you must first complete the procedure, "ER Create a configuration

provider and mark it as active".

The steps in this procedure explain how to design Electronic reporting (ER) configurations to generate an

electronic document. In this procedure, you will import the required ER configurations that have been created

for the sample company, Litware, Inc. and use them to generate electronic documents. This procedure is created

for users with the assigned role of system administrator or electronic reporting developer. These steps can be

completed using the DEMF dataset. Before you begin, download and save the files listed in the Help topic,

"Generate electronic documents and update application data with ER tool" (generate-electronic-documents-

update-application-data/). The files are Intrastat (model).xml, Intrastat (mapping).xml, and Intrastat (format).xml.

1. Go to Organization administration > Workspaces > Electronic reporting.

Make sure that the configuration provider for the sample company, Litware, Inc., is available and

marked as Active. If you don't see this configuration provider, complete the steps in the procedure,

Create a configuration provider and mark it as active.

The steps in this procedure show how to use ER capabilities to complete an application data update

and how to generate an Intrastat report. The details of the reporting process are archived in the

application tables. Currently, when the Intrastat reporting process is activated from the Intrastat form,

archiving is done based on the logic programmed in the existing source code. In this procedure, you

will configure a similar yet simplified logic of application data using only the ER framework. No

changes will be made to the source code.

1. Click Reporting configurations.

2. Click Exchange.

3. Click Load from XML file.

4. Click OK.

5. In the tree, select 'Intrastat (model)'.

6. Click Designer.

7. In the tree, expand 'For outgoing document'.

8. In the tree, expand 'For outgoing document\Transactions'.

9. Close the page.

10. Click Exchange.

Import the ER model configuration that contains the data model that is designed to be used as the

data source for generating the Intrastat report. Later, you will extend this data model definition to use

it for an application data update to archive details of the Intrastat reporting process.

Click Browse and select the Intrastat (model).xml file.

Review the structure of the imported data model. Note that the root item 'For outgoing document' is

defined to specify the data flow for getting data from the application and using it as data source to

generate the Intrastat report. The 'Transactions (Record list)' is used to represent the list of Intrastat

transactions that must be reported. Because you will archive reported commodity codes, the unique

identifier of a single commodity code 'Commodity rec id (Int64)' is needed in this data flow.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-generate-documents-application-data-update-part-1-import-configurations.md


NOTENOTE

11. Click Load from XML file.

12. Click OK.

13. In the tree, expand 'Intrastat (model)'.

14. In the tree, select 'Intrastat (model)\Intrastat (mapping)'.

15. Click Designer.

16. Click Designer.

17. In the tree, expand 'List'.

18. In the tree, expand 'Transactions= List'.

19. Close the page.

20. Close the page.

21. Click Exchange.

22. Click Load from XML file.

23. Click OK.

24. In the tree, select 'Intrastat (model)\Intrastat (format)'.

25. Click Designer.

26. Click Expand/collapse.

27. In the tree, select 'File\Declaration'.

28. Click the Mapping tab.

29. In the tree, select 'File'.

30. Close the page.

Import the ER mapping configuration that specifies the data flow for getting data from the application

and then using it to generate the Intrastat report. Later, you will extend this model mapping definition

to get data from the Intrastat report and use it for the application data update to archive details of

Intrastat reporting process.

Click Browse and select the Intrastat (mapping).xml file.

Note that the current model mapping contains the value 'To model' in the Direction field. This means

that this model mapping has been designed for getting data from the application and storing it in the

data model.

Review the structure of the model mapping that uses the data model that is filtered based on the root

item, 'For outgoing document.' Note that the added data source, 'List' provides access to the required

application data, which is the list of records from the Intrastat table.

Import the ER format configuration that specifies the layout of the Intrastat report and the process of

populating data to the report. Later, you will extend this format definition to put data from the Intrastat

report in to the data model and then use it to update application data to archive the details of Intrastat

reporting process.

Click Browse and select the Intrastat (format).xml file.

Review the structure of the format used to generate the Intrastat report. Note that it is designed to

generate an XML file by populating data from the data model, which is based on the root item 'For

outgoing document'. Verify that the name for generated file is defined on the user dialog form ('fn'

data source is used for that).

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Run imported ER format

NOTENOTE

To complete the steps in this procedure, you must first complete the procedure, ER Generate documents with

application data update (Part 1: Import configurations).

The steps in this procedure explain how to design Electronic reporting (ER) configurations to generate an

electronic document. In this procedure, you run the ER imported format configuration that has been created for

the sample company, Litware, Inc. to generate electronic documents.

This procedure is created for users with the assigned role of system administrator or electronic reporting

developer. These steps can be completed using the DEMF dataset.

Before you begin, change the country context for the DEMF company from DEU (Germany) to BEL (Belgium).

Click Organization administration > Organizations > Legal entities to update the country code in the primary

address of the legal entity DEMF. Restart your application.

1. Go to Organization administration > Electronic reporting > Configurations.

2. In the tree, expand 'Intrastat (model)'.

3. In the tree, select 'Intrastat (model)\Intrastat (format)'.

4. Click Run.

5. In the Enter file name field, type 'intrastat.xml'.

6. Click OK.

7. Close the page.

8. Go to Tax > Declarations > Foreign trade > Intrastat.

9. Click Intrastat archive.

10. Close the page.

11. Close the page.

Run the draft version of the ER format configuration to generate the Intrastat report.

Specify the name of the file.

Review the generated XML file.

Open this form to view the Intrastat transactions that are included in the generated electronic

document.

Because the executed ER format does not contain any settings for application data update, the details

of the completed Intrastat report have not been archived.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Modify data model

To complete the steps in this procedure, you must first complete the procedure, "ER Generate documents with

application data update (Part 2: Generate documents)".

The steps in this procedure explain how to design Electronic reporting (ER) configurations to generate an

electronic document and update application data. In this procedure, you will modify the ER configurations to

start using them to generate electronic documents and update application data. This procedure is created for

users with the assigned role of system administrator or electronic reporting developer. These steps can be

completed using the DEMF dataset.

1. Go to Organization administration > Electronic reporting > Configurations.

2. In the tree, select 'Intrastat (model)'.

3. Click Designer.

4. Click New to open the drop dialog.

5. In the New node as a field, enter 'Model root'.

6. In the Name field, type 'For application data update'.

7. Click Add.

8. In the tree, select 'For application data update'.

9. Click New to open the drop dialog.

10. In the Name field, type 'Archive header'.

11. In the Item type field, select 'Record list'.

12. Click Add.

13. Click New to open the drop dialog.

14. In the Name field, type 'File name'.

15. In the Item type field, select 'String'.

16. Click Add.

17. Click New to open the drop dialog.

18. In the Name field, type 'Number of lines'.

You will extend how you use the data model. Besides using it as data source to generate the Intrastat

report, the data model will be used to collect details about the Intrastat reporting process. The details

will then be used to update application data.

For application data update

This new root item is added to specify the data flow for moving data from the Intrastat report (used as

a data source) to the application tables (the update destination). Note that different root items must be

used for getting data that is posted to the outgoing document and for getting data from the document

that is used to update application data.

Archive header

Because you will create a record for each Intrastat report that is generated, you must create a new

item for that.

File name

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-generate-documents-application-data-update-part-3-modify-model-mapping.md
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19. In the Item type field, select 'Integer'.

20. Click Add.

21. Click New to open the drop dialog.

22. In the Name field, type 'Archive lines'.

23. In the Item type field, select 'Record list'.

24. Click Add.

25. Click New to open the drop dialog.

26. In the Name field, type 'Amount'.

27. In the Item type field, select 'Real'.

28. Click Add.

29. Click New to open the drop dialog.

30. In the Name field, type 'Commodity rec id'.

31. In the Item type field, select 'Int64'.

32. Click Add.

33. Click New to open the drop dialog.

34. In the Name field, type 'Item number'.

35. In the Item type field, select 'String'.

36. Click Add.

37. Click Save.

38. Close the page.

Number of lines

Add this item to represent the number of Intrastat transactions that are reported during the current

reporting process.

Archive lines

Add this item to represent the list of Intrastat transactions that are reported during the current

reporting process.

Amount

Commodity rec id

Item number

1. In the tree, expand 'Intrastat (model)'.

2. In the tree, select 'Intrastat (model)\Intrastat (mapping)'.

3. Click Designer.

4. Click New.

5. In the Name field, type 'Update archive'.

6. In the Direction field, select 'To destination'.

7. Click Save.

8. Click Designer.

9. In the tree, select 'Data model\Data model'.

Modify the existing model mapping to start using it for the application data update and to archive

Intrastat reporting details.

Update archive

This new mapping specifies the data flow for moving data (Intrastat reporting details) from the data

model to the application tables (the update destination). Note that different model's root items must

be used to get data from the application for the reporting process and then use the data from data

model for the application data update.



10. Click Add root.

11. In the Name field, type 'model'.

12. In the Definition field, enter or select the value 'For application data update'.

13. Click OK.

14. In the tree, expand 'model'.

15. In the tree, select 'Functions\Calculated field'.

16. In the tree, select 'model\Archive header'.

17. Click Add.

18. In the Name field, type 'Enumerated lines'.

19. Click Edit formula.

20. In the tree, select 'List\ENUMERATE'.

21. Click Add function.

22. In the tree, expand 'model'.

23. In the tree, expand 'model\Archive header'.

24. In the tree, select 'model\Archive header\Archive lines'.

25. Click Add data source.

26. In the Formula field, enter 'ENUMERATE(model.'Archive header'.'Archive lines')'.

27. Click Save.

28. Close the page.

29. Click OK.

30. Click Add destination.

31. In the Name field, type 'Archive'.

32. In the Table name field, type 'IntrastatArchiveGeneral'.

33. Select Yes in the Record infolog field.

34. Select Yes in the Skip record action validation field.

35. Click OK.

36. In the tree, expand 'Archive'.

Add the required data source. This is the data model that contains details of the reported Intrastat

transactions that must be archived.

model

For application data update

Because you want to enumerate reported Intrastat transactions for archiving, the appropriate data

source must be added.

Enumerated lines

ENUMERATE(model.'Archive header'.'Archive lines')

Add application tables as required destinations that require updates to archive details of reported

Intrastat transactions.

Archive

IntrastatArchiveGeneral

Keep the record action 'Insert' so you can add records during the detail archiving of each Intrastat

reporting process.

Select Yes to get information about issues with the application data update.

Select Yes to suppress validation errors about the empty 'Intrastat archive ID' field. This will be done

after records are added, based on the sequence number settings that are configured for this table in

the Foreign trade parameters form.

Bind elements of the added data source (the filtered model based on the selected root item) with

elements from the added destination.



NOTENOTE

37. In the tree, expand 'Archive<Relations'.

38. In the tree, expand 'Archive<Relations\IntrastatArchiveDetail'.

39. In the tree, select 'Archive<Relations\IntrastatArchiveDetail\Amount(AmountMST)'.

40. In the tree, expand 'model\Archive header\Enumerated lines'.

41. In the tree, expand 'model\Archive header\Enumerated lines\Value'.

42. In the tree, select 'model\Archive header\Enumerated lines\Value\Amount'.

43. Click Bind.

44. In the tree, select 'Archive<Relations\IntrastatArchiveDetail\Commodity(IntrastatCommodity)'.

45. In the tree, select 'model\Archive header\Enumerated lines\Value\Commodity rec id'.

46. Click Bind.

47. In the tree, select 'Archive<Relations\IntrastatArchiveDetail\Item number(ItemId)'.

48. In the tree, select 'model\Archive header\Enumerated lines\Value\Item number'.

49. Click Bind.

50. In the tree, select 'Archive<Relations\IntrastatArchiveDetail\Line number(LineNumber)'.

51. In the tree, select 'model\Archive header\Enumerated lines\Number'.

52. Click Bind.

53. In the tree, select 'Archive<Relations\IntrastatArchiveDetail'.

54. In the tree, select 'model\Archive header\Enumerated lines'.

55. Click Bind.

56. In the tree, select 'Archive\File name(FileName)'.

57. In the tree, select 'model\Archive header\File name'.

58. Click Bind.

59. In the tree, select 'Archive\Number of lines(NumberOfLines)'.

60. In the tree, select 'model\Archive header\Number of lines'.

61. Click Bind.

62. In the tree, select 'Archive'.

63. In the tree, select 'model\Archive header'.

64. Click Bind.

65. Click Save.

66. Close the page.

67. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Modify format to collect details of reporting

To complete the steps in this procedure, you must first complete the procedure, "ER Generate documents with

application data update (Part 3: Modify model and mapping)".

The steps in this procedure explain how to design Electronic reporting (ER) configurations to generate an

electronic document and update application data. In this procedure, you will modify the ER configurations to not

just use them to generate electronic documents, but also to update application data. This procedure is created

for users with the assigned role of system administrator or electronic reporting developer. These steps can be

completed using the DEMF dataset.

1. Go to Organization administration > Electronic reporting > Configurations.

2. In the tree, expand 'Intrastat (model)'.

3. In the tree, select 'Intrastat (model)\Intrastat (format)'.

4. Click Designer.

5. In the tree, expand 'File'.

6. In the tree, expand 'File\Declaration'.

7. In the tree, select 'File\Declaration\Data'.

8. In the Multiplicity field, select 'One many'.

9. In the tree, expand 'File\Declaration\Data'.

10. In the tree, select 'File\Declaration\Data\Item'.

11. In the Multiplicity field, select 'Zero many'.

12. In the tree, expand 'File\Declaration\Data\Item'.

13. In the tree, select 'File\Declaration\Data\Item\Dim1'.

14. Select Yes in the Excluded field.

15. In the tree, expand 'File\Declaration\Data\Item\Dim1'.

16. In the tree, select 'File\Declaration\Data\Item\Dim1\property'.

17. Select Yes in the Excluded field.

18. In the tree, select 'File\Declaration\Data\Item\Dim1\date'.

19. Select Yes in the Excluded field.

20. In the tree, select 'File\Declaration\Data\Item\Dim2'.

21. Select Yes in the Excluded field.

22. In the tree, expand 'File\Declaration\Data\Item\Dim2'.

23. In the tree, select 'File\Declaration\Data\Item\Dim2\property'.

24. Select Yes in the Excluded field.

Configure this format element to archive details of the Intrastat reporting process. This item

represents the archive's header record.

Configure this format element to archive details of the Intrastat reporting process. This item will

represent the list of archived lines.

You will not archive this data, so you can exclude this format element from the data source of Intrastat

reporting details.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-generate-documents-application-data-update-part-4-modify-format.md
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25. In the tree, select 'File\Declaration\Data\Item\Dim2\code'.

26. Select Yes in the Excluded field.

27. In the tree, select 'File\Declaration\Data\Item\Dim3'.

28. In the Name field, type 'Amount'.

29. In the Multiplicity field, select 'Exactly one'.

30. In the tree, select 'File\Declaration\Data\Item\Dim4'.

31. In the Name field, type 'Item'.

32. In the Multiplicity field, select 'Exactly one'.

33. In the tree, select 'File\Declaration\Data'.

34. Click Add to open the drop dialog.

35. In the tree, select 'Data source\Item'.

36. In the Name field, type 'File name'.

37. In the Data type field, select 'String'.

38. Click OK.

39. In the tree, select 'File\Declaration\Data\Item'.

40. Click Add Item.

41. In the Name field, type 'Commodity rec ID'.

42. In the Data type field, select 'Int64'.

43. Click OK.

44. Click the Mapping tab.

45. In the tree, select 'File\Declaration\Data\File name'.

46. Click Bind.

47. In the tree, expand 'model'.

48. In the tree, expand 'model\Transactions'.

49. In the tree, select 'File\Declaration\Data\Item = model.Transactions\Commodity rec ID'.

50. In the tree, select 'model\Transactions\Commodity rec ID'.

51. Click Bind.

52. Click Save.

Several format elements can have the same name. For example, Dim. You cannot explicitly recognize

them when you use this format as a data source for archiving Intrastat reporting details, so you need

to define the alternative names for these format elements.

Amount

Item

In addition to the design format elements, the following Intrastat reporting details must be archived:

unique record identification of each reported commodity item and name of the generated file.

Because this data will not be populated in the Intrastat report, you need to add the format that is

related to these detail elements as data source items.

File name

Commodity rec ID

1. Click Map format to model.

2. Click New.

3. In the Definition field, enter or select the 'For application data update' root item.

4. In the Name field, type 'Mapping to update data'.

For application data update.

Mapping to update data



5. Click Save.

6. Click Designer.

7. In the tree, expand 'Archive header'.

8. In the tree, expand 'Archive header\Archive lines'.

9. In the tree, expand 'format'.

10. In the tree, expand 'format\Declaration: XML Element(Declaration)'.

11. In the tree, expand 'format\Declaration: XML Element(Declaration)\Data: XML Element 1..* (Data)'.

12. In the tree, expand 'format\Declaration: XML Element(Declaration)\Data: XML Element 1..* (Data)\Item: XML

Element 0..* (Item)'.

13. In the tree, expand 'format\Declaration: XML Element(Declaration)\Data: XML Element 1..* (Data)\Item: XML

Element 0..* (Item)\Dim3: XML Element 1..1 (Amount)'.

14. In the tree, expand 'format\Declaration: XML Element(Declaration)\Data: XML Element 1..* (Data)\Item: XML

Element 0..* (Item)\Dim4: XML Element 1..1 (Item)'.

15. In the tree, select 'Archive header\Number of lines'.

16. Click Edit.

17. In the tree, select 'List\COUNT'.

18. Click Add function.

19. In the tree, expand 'format'.

20. In the tree, expand 'format\Declaration: XML Element(Declaration)'.

21. In the tree, expand format\Declaration: XML Element(Declaration)\Data: XML Element 1..* (Data) .

22. In the tree, select 

format\Declaration: XML Element(Declaration)\Data: XML Element 1..* (Data)\Item: XML Element 0..* (Item) .

23. Click Add data source.

24. In the Formula field, enter 'COUNT(format.Declaration.Data.Item)'.

25. Click Save.

26. Close the page.

27. In the tree, select 'Archive header\File name'.

28. In the tree, select 'format\Declaration: XML Element(Declaration)\Data: XML Element 1..* (Data)\File name:

Item String(File name)'.

29. Click Bind.

30. In the tree, select 
format\Declaration: XML Element(Declaration)\Data: XML Element 1..* (Data)\Item: XML Element 0..*
(Item)\Dim4: XML Element 1..1 (Item)\number: String(number)

.

31. In the tree, select 'Archive header\Archive lines\Item number'.

32. Click Bind.

33. In the tree, select 
format\Declaration: XML Element(Declaration)\Data: XML Element 1..* (Data)\Item: XML Element 0..*
(Item)\Dim3: XML Element 1..1 (Amount)\value: Numeric Real(value)

This mapping defines how the details of the Intrastat report are collected in the data model, the

structure of which is specified by the selected root item 'For application data update'. These details, the

model mapping with same root item 'For application data update', and the direction 'To destination'

will be used for the application data update. The application data update starts immediately after the

outgoing Intrastat report is generated. The application data update can be skipped at run-time, but the

data model must be empty (containing empty record list).

The outgoing Intrastat report format is added by default as a data source for this model mapping.

Bind elements of the designed report (presented as data source) to elements of the data model, which

is filtered based on the selected model's root item.

COUNT(format.Declaration.Data.Item)
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.

34. In the tree, select 'Archive header\Archive lines\Amount'.

35. Click Bind.

36. In the tree, select 
format\Declaration: XML Element(Declaration)\Data: XML Element 1..* (Data)\Item: XML Element 0..*
(Item)\Commodity rec ID: Item Int64(Commodity rec ID)

.

37. In the tree, select 'Archive header\Archive lines\Commodity rec ID'.

38. Click Bind.

39. In the tree, select 'Archive header\Archive lines'.

40. In the tree, select 

format\Declaration: XML Element(Declaration)\Data: XML Element 1..* (Data)\Item: XML Element 0..* (Item) .

41. Click Bind.

42. In the tree, select 'Archive header'.

43. In the tree, select format\Declaration: XML Element(Declaration)\Data: XML Element 1..* (Data) .

44. Click Bind.

45. Click Save.

46. Close the page.

47. Close the page.

48. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Set up foreign trade parameters

Run modified ER format

Review ER format execution's results

To complete the steps in this procedure, you must first complete the procedure, "ER Generate documents with

application data update (Part 4: Modify format)".

The steps in this procedure explain how to design Electronic reporting (ER) configurations to generate an

electronic document and update application data. In this procedure, you execute the ER format configuration to

generate the Intrastat report and update application data for archiving details of the reporting process.

This procedure is created for users with the assigned role of system administrator or electronic reporting

developer. These steps can be completed using the DEMF dataset. Before you begin, make sure that the country

context for the DEMF company is BEL (Belgium).

1. Go to Tax > Setup > Foreign trade > Foreign trade parameters.

2. Click the Number sequences tab.

Archiving details of Intrastat reporting process, we need to identify records of each archive we created. A

special number sequence must be configured for that.

3. Select the 'Intrastat archive ID' reference.

4. In the Number sequence code field, type a value.

In the 'Number sequence code' field, enter or select the value 'Fore_2'.

5. ResolveChanges the Number sequence code.

6. Click Save.

7. Close the page.

1. Go to Organization administration > Electronic reporting > Configurations.

2. In the tree, expand 'Intrastat (model)'.

3. In the tree, select 'Intrastat (model)\Intrastat (format)'.

4. Click Run.

5. In the Enter file name field, type 'intrastat2.xml'.

6. Click OK.

Review the generated XML file.

1. Close the page.

2. Go to Tax > Declarations > Foreign trade > Intrastat.

Open this form containing Intrastat transactions that have been included to the generated electronic

document.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-generate-documents-application-data-update-part-5-generate-documents-application-data-update.md
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3. Click Intrastat archive.

Since the executed ER format contains now settings for application data update, the details of the

completed Intrastat reporting have been archived. In this form, you can see the header record of the

created archive.

4. Click Details.

In this form, you can see the details for the created archive.

5. Close the page.

6. Close the page.

7. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Parse incoming documents to update application data

C O N T EN T  DESC RIP T IO NC O N T EN T  DESC RIP T IO N F IL EF IL E

ER data model configuration EFSTAmodel.xml

ER format configuration EFSTAformat.xml

Web service response sample 1 Response1.xml

Web service response sample 2 Response2.xml

Web service response sample 3 Response3.xml

Web service response sample 4 Response4.xml

This topic covers the following three tasks:

Parse incoming documents to update application data

Parse incoming documents in Excel format

Parse incoming documents in CSV format

You can design Electronic reporting (ER) formats and run them in the application to parse incoming electronic

documents and then use their content to update application data.

The following new ER functionality that has been introduced improves the parsing of incoming electronic

documents in XML format:

The CASECASE format element can be used as a root element of the ER format that is configured to parse

incoming electronic documents in XML format. The FILEFILE format element is supported as a nested

element of the CASECASE element. Therefore, you can configure a single ER format to parse incoming

electronic documents that might contain different root XML elements.

A Parsing order of nested elementsParsing order of nested elements  attribute has been introduced for XML format elements in ER

formats. You can use this attribute to define a single XML element that is expected in the incoming file.

There are two valid sequences of the nested elements:

As in formatAs in format – The incoming file is valid when the sequence of nested elements in the file is the same

as the order that is described in the ER format.

AnyAny  – The incoming file is valid when all nested elements in the ER format are present in the parsing

file, regardless of their sequence in that file.

To become more familiar with the details of this feature, play the task guide, ER - Parse incoming documents to

update application data (part of the 7.5.4.3 Acquire/Develop IT service/solution components (10677) business

process). This task guide shows how the responses from a web service can be parsed by using an ER format.

To complete some steps of the task guide, you must download the following files:

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-parse-incoming-documents.md
https://go.microsoft.com/fwlink/?linkid=862266
https://go.microsoft.com/fwlink/?linkid=862266
https://go.microsoft.com/fwlink/?linkid=862266
https://go.microsoft.com/fwlink/?linkid=862266
https://go.microsoft.com/fwlink/?linkid=862266
https://go.microsoft.com/fwlink/?linkid=862266


 

 

Parse incoming documents in Excel format

C O N T EN T  DESC RIP T IO NC O N T EN T  DESC RIP T IO N F IL EF IL E

Incoming file in .XLSX format - template 1099import-template.xlsx

Incoming file in .XLSX format - sample data 1099import-data.xlsx

C O N T EN T  DESC RIP T IO NC O N T EN T  DESC RIP T IO N F IL EF IL E

ER model configuration 1099model.xml

Parse incoming documents in CSV format

You can design Electronic reporting (ER) formats to parse incoming Microsoft Excel files that represent data in

Microsoft Excel workbooks (files in XLSX format). You can then use the content from these files to update

application data. This is useful if you:

Design a new model and format and want to test them at run-time. In this case, Excel will simulate the actual

application data.

Manage data beyond your application in Excel and want to import this data to submit a specific report.

To learn more about this feature, play the task guides ER Impor t data from a Microsoft Excel file (Par t 1 :ER Impor t data from a Microsoft Excel file (Par t 1 :

Design format)Design format)  and ER Impor t data from a Microsoft Excel file (Par t 2 : Impor t data)ER Impor t data from a Microsoft Excel file (Par t 2 : Impor t data)  (parts of the

7.5.4.3 Acquire/Develop IT service/solution components (10677) business process). These task guides walk

through how the incoming Excel file can be parsed by using the ER format to import information from incoming

documents and update application data. You can download the task guide files from the Microsoft Download

Center.

Download the following files to complete the task guides mentioned above.

If you have not yet played the following task guide, ER Create required configurations to import data from an

external file in the current Finance and Operations application, download the following file.

You can design Electronic reporting (ER) formats to parse incoming electronic documents that represent tabular

data in plain text (files in CSV format) and then use the content from these documents to update application

data. The following approach can be used:

Begin your format's design by adding a new root sequence element to specify that each line in the

parsing file is considered a separate record.

In the added sequence element, select the appropriate value, for example New line - Windows (CRNew line - Windows (CR

LF)LF) , in the Special charactersSpecial characters  field in the Sequence element delimiterSequence element delimiter  field group.

Continue your format's design by adding a nested sequence element of the added root sequence element

to specify that each line in the parsing file is considered as a set of fields.

You can specify the character in the Custom delimiterCustom delimiter  field that will be recognized in the parsing

line as a fields separator.

https://go.microsoft.com/fwlink/?linkid=874684
https://go.microsoft.com/fwlink/?linkid=862266
https://go.microsoft.com/fwlink/?linkid=862266
https://go.microsoft.com/fwlink/?linkid=862266
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ER format configuration 1099formatcsv.xml

Sample of incoming file in .csv format 1099entriescsv.csv

NOTENOTE
You can define different field separators for different sequence elements to parse specific file lines in

which fields are separated by different characters.

The Custom delimiterCustom delimiter  field can be left blank for certain sequence elements. An empty field means

that any file line that is parsed by using this sequence will be parsed like a .txt (fixed length text) file line.

In the Quotation applicationQuotation application field, select the value when you expect that some fields of any line

that is parsed by this sequence element will be enclosed by certain characters. The following

options are available:

AllAll  – Include quotation characters in the parsing line for any field of any data type. If you select

this, define the desired characters in the Quotation markQuotation mark field that will be used for fields

quotation. For example, the double quotes character.

Text onlyText only  – Include quotation characters in the parsing line for any field of the Str ingStr ing data

type. If you select this, define the desired characters in the Quotation markQuotation mark field that will be

used for fields quotation.

Derive from parent onlyDerive from parent only  – Use the same Quotation applicationQuotation application field settings that are

defined for the parent sequence element. Note that the Quotation markQuotation mark field setting will be

taken from the settings of the parent sequence element as well.

NoneNone – Exclude quotation characters in the parsing line for any field of any data type.

Complete your format's design by adding nested elements for the added sequence element that

represents the set of fields of the parsing line. Add the required elements of the TextText group, such as

Str ingStr ing, DateTimeDateTime, and NumericNumeric, to describe the structure of the parsing line as a set of individual fields

of different data types.

NOTENOTE

For each format element that represents an individual field of the parsing line, by default, nothing

is selected in the MultiplicityMultiplicity  field. This means that the value of the field in the parsing line is

considered required. In the MultiplicityMultiplicity  field, select Zero oneZero one to consider the value of this field in

the parsing line as optional.

The data source item isMatchisMatch is available when you map this format to ER data model for each StringString,

DateTimeDateTime, or NumericNumeric format element with the option Zero oneZero one selected in the MultiplicityMultiplicity  field.

When this field contains a value, isMatchisMatch will return TrueTrue. If there is no value in the field, it will return

FalseFalse.

To learn more about this feature, play the task guide, ER Create a format configuration to impor t dataER Create a format configuration to impor t data

from an external CSV filefrom an external CSV file (part of the 7.5.4.3 Acquire/Develop IT service/solution components (10677)

business process), which walks through how the incoming CSV file can be parsed by using the ER format to

update application data.

Download the following files to complete the task guide mentioned above.

Download the following file that is required to complete the task guide mentioned above if you have not played

the task guide, ER Create required configurations to impor t data from an external file for electronicER Create required configurations to impor t data from an external file for electronic

https://go.microsoft.com/fwlink/?linkid=862266
https://go.microsoft.com/fwlink/?linkid=862266
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ER model configuration 1099model.xml

NOTENOTE

repor tingrepor ting in the current Finance and Operations application.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Add a new ER model configuration

Review data model settings

The following steps explain how a user in the System administrator or Electronic reporting developer role can

design Electronic reporting (ER) configurations to import data in to the application from an external file. In this

example, you will create the required ER configurations for the sample company, Litware, Inc. To complete these

steps, you must first complete the steps in the Task guide, "ER Create a configuration provider and mark it as

active." These steps can be completed using the USMF data set. You must also download and save the following

files locally using links from the Electronic reporting overview topic (https://go.microsoft.com/fwlink/?

linkid=852550): 1099model.xml, 1099format.xml, 1099entries.xml, 1099entries.xlsx.

ER offers business users the ability to configure the process of importing external data files to tables in either

.XML or .TXT format. First, an abstract data model and an ER data model configuration must be designed to

represent the data that you are importing. Next, you need to define the structure of the file that you are

importing and the method that you will use to port the data from the file to the abstract data model. The ER

format configuration that maps to the designed data model must be created for that abstract data model. Then,

the data model configuration must be extended with a mapping that describes how the imported data is

persisted as abstract data model data and how it is used to update tables. The ER data model configuration must

be appended with a new model mapping that describes the binding of the data model to the application's

destinations.

The following scenario shows the ER data import capabilities. This includes vendor transactions that are tracked

externally and then imported to be reported later in Vendor's settlement for 1099's.

1. Go to Organization administration > Workspaces > Electronic reporting.

Verify that the configuration provider for sample company 'Litware, Inc.' is available and marked as

active. If you don't see this configuration provider, you must first complete the steps in the procedure,

"Create a configuration provider and mark it as active."

2. Click Reporting configurations.

Instead of creating of a new model to support data import, load the file, 1099model.xml, that you

previously downloaded. This file contains the custom data model of vendors' transactions. This data

model is mapped to the data components that are in the AOT data entity.

3. Click Exchange.

4. Click Load from XML file.

Click Browse and navigate to the 1099model.xml file that you previously downloaded.

5. Click OK.

6. In the tree, select '1099 Payments model'.

1. Click Designer.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-required-configurations-import-data.md
https://go.microsoft.com/fwlink/?linkid=852550


Add a new ER format configuration that supports data import

Review format settings

Review the settings of the format mapping to the data model

This model is designed to represent vendors' transactions from the business standpoint and are separate

from the implementation.

2. In the tree, expand '1099-MISC'.

3. In the tree, select '1099-MISC\Transactions'.

4. In the tree, expand '1099-MISC\Transactions'.

The Transactions element of this model represents individual transactions. The child elements are used to

specify required details, such as vendor account and transaction date, for each transaction.

5. Close the page.

The steps in this subtask show you how a new format configuration can be created to manage data import from

external files.

1. Click Create configuration to open the drop dialog.

2. In the New field, enter 'Format based on data model 1099 Payments model'.

3. Select Yes in the Supports data import field.

4. Press ESC key to close this page.

Instead of creating a new format to support data import, load the 1099format.xml file that you previously

downloaded. This file contains the defined structure of the file you are importing and the mapping of the

structure to the custom data model of vendors' transactions.

5. Click Exchange.

6. Click Load from XML file. Click Browse and navigate to the 1099format.xml file that you previously

downloaded.

7. Click OK.

8. In the tree, expand '1099 Payments model'.

9. In the tree, select '1099 Payments model\Format for importing vendors' transactions'.

1. Click Designer.

2. Toggle 'Show details' on.

3. Click Expand/collapse.

4. Click Expand/collapse.

The designed format represents the expected structure of the external file. This file must be in XML format

and have the settlement root element. Each vendor's transaction is represented by the transaction

element that is defined as having zero-to-many multiplicity. This means that the incoming file may

contain anywhere from zero to multiple transactions. Nested elements of the 'transaction' element

represent a single transaction's attributes. Note that all attributes, except country, are marked as

mandatory, meaning that it is required to have them in the importing file.



Run the format mapping to the data model

1. Click Map format to model.

The mapping 'For importing vendors' transactions' contains the data transfer rules from the incoming

XML file to the selected part of the custom data model, which is defined by selecting the1099-MISC

definition.

2. Click Designer.

3. Toggle 'Show details' on.

4. In the tree, expand 'format: Record'.

5. In the tree, select 'format: Record'.

Note that the designed format is presented here as a data source component.

6. In the tree, expand format: Record\*settlement: XML Element 1..1 (settlement): Record .

7. In the tree, expand 
format: Record\*settlement: XML Element 1..1 (settlement): Record\transaction: XML Element 0..*
(transaction): Record list

.

8. In the tree, expand 
format: Record\*settlement: XML Element 1..1 (settlement): Record\transaction: XML Element 0..*
(transaction): Record list\*vendor: XML Element 1..1 (vendor): Record

.

9. In the tree, expand 
format: Record\*settlement: XML Element 1..1 (settlement): Record\transaction: XML Element 0..*
(transaction): Record list\country: XML Element 0..1 (country): Record

.

10. In the tree, select 
format: Record\*settlement: XML Element 1..1 (settlement): Record\transaction: XML Element 0..*
(transaction): Record list\*vendor: XML Element 1..1 (vendor): Record

.

Note that the presentation of mandatory and optional format elements is different in the predefined

'format' data source component.

11. In the tree, expand 'Transactions: Record list= format.settlement.'$enumerated''.

Note that the elements of the format that defines the structure of the imported file are bound to the

elements of the custom data model. Based on these bindings, the content of the imported XML file will be

stored at run-time in the existing data model. Pay attention to the binding of the country element. For any

transaction element in the incoming file that has no such element, the default country code 'USA' will be

populated in the data model.

12. Click the Validations tab.

This format mapping may contain user-defined logic to validate the accuracy of the imported data from a

business standpoint. For example, based on the setting, for any transaction in the importing file without a

defined country code, a warning message will be generated in the Infolog informing the user about the

case and indicating the transaction's sequence number.

13. Close the page.

Execute this format mapping for testing purposes. Use the file 1099entries.xml that you previously downloaded.



Review the settings for the model mapping to the destinations

You can export this file from the 1099entries.xlsx workbook that is used to manage vendor transactions. The

generated output will be imported from the selected XML file and populate the custom data model at real

import.

1. Click Run.

Click Browse and navigate to the 1099entries.xml file that you previously downloaded.

2. Click OK.

Note the warning message about a missing country code for a transaction in the imported file.

Review the output in XML format, which represents the data that has been imported from the selected file

and ported to the data model.

3. Close the page.

4. Close the page.

1. In the tree, select '1099 Payments model'.

2. Click Designer.

3. Click Map model to datasource.

The mapping For 1099 manual transactions import has been defined with the To destination direction

type. This means that it has been entered to support data import and contains the setting of rules

defining how the imported external file and persisted as abstract data model data is used to update tables

in the application.

4. Click Designer.

5. In the tree, expand 'model: Data model 1099 Payments model'.

6. In the tree, expand 'model: Data model 1099 Payments model\Transactions: Record list'.

Note that the designed model is presented here as a data source element. At runtime, it will contain the

data that is imported from the external file. Several tables were added as data source elements to ensure

that the imported data is compliant with the data of the current application, including whether the

importing transaction vendor account is available in the system, whether the combination of the

importing country and state codes exists, etc.

7. In the tree, select 'model: Data model 1099 Payments model\Transactions: Record list$failed: Calculated

field = IF(OR(ISEMPTY(model.Transactions.'$refs'.vendor),

ISEMPTY(model.Transactions.'$refs'.vendor1099), ISEMPTY(model.Transactions.'$refs'.box1099),

ISEMPTY(model.Transactions.'$refs'.country), ISEMPTY(model.Transactions.'$refs'.state),

ISEMPTY(model.Transactions.'$refs'.location)), true, false): Boolean'.

8. Click Edit.

9. Click Edit formula.

When at least one validation fails for a single imported transaction, this transaction will be marked as

failed by the data source attribute '$failed'.

10. Close the page.

11. Click Cancel.



12. In the tree, select 'tax1099trans: Table 'VendSettlementTax1099' records= model.Validated'.

13. Click Edit destination.

This ER destination was added to specify how the imported data will update the application tables. In this

case, the data table VendSettlementTax1099 has been selected. Because the record action Insert has been

selected, the imported transactions will be inserted in the table VendSettlementTax1099. Note that a

single model mapping may contain several destinations. This means that the imported data can be used

to update multiple application's tables at once. Tables, views, and data entities can be used as ER

destinations.

If the mapping will be called from a point in the application (such as button or menu item) that was

specifically designed for this action, the ER destination should be marked as the integration point. In this

example this is the ERTableDestination#VendSettlementTax1099 point.

14. Click Cancel.

15. Click Show all.

16. Click Show mapped only.

17. In the tree, expand 'tax1099trans: Table 'VendSettlementTax1099' records= model.Validated'.

Note that the data source element that contains the only validated transactions is bound to the created

destination. You can filter the imported transactions to skip the ones that are incompatible with the

applications' data.

18. In the tree, select 'failed: Table 'VendSettlementTax1099Entity' records= model.Failed'.

19. Click the Validations tab.

This model mapping may contain user-defined logic to validate the correctness of the imported data

from the existing application data. For example, based on the present setting, for any transaction in the

imported file with a vendor account that is not in the system, a warning message will be generated

informing the user and indicating the incorrect vendor account code.

Note that the Post validation action option can be used for each validation, to specify whether the import

process must be continued or stopped, as well as if the already performed inserts/updates can be kept or

rolled back.

20. Click Show mapped only.

21. Click Show all.

22. Close the page.

Execute this model mapping to test the designed format and model mappings. Use the file

1099entries.xml. The data from the selected file will be imported in to the system.

23. Click Run.

Note that the dialog box contains no additional questions about the format mapping that must be used to

parse the imported file and then port the data to the data model. This is because there is currently only

one format that uses this model, which is marked as designed to support data import.

Define the voucher ID to differentiate the imported transactions from other transactions that may already

have been entered manually or imported.

24. In the Enter voucher id field, type 'IMPORT-001'.

Browse to get the '1099entries.xml' file.



Review the relationship between model and format mappings

25. Click OK.

The list of generated warnings provides information about incorrect vendor accounts, an incorrect tax

1099 box code, missing country codes, etc. Compare this list of warnings to the content that is included in

the execution XML file.

26. Close the page.

27. Close the page.

28. Close the page.

29. Close the page.

30. Go to Accounts payable > Periodic tasks > Tax 1099 > Vendor settlement for 1099s.

This form shows the cumulative transactions in the Tax1099Summary table that have been created based

on imported transactions.

31. In the From date field, set the date to '2000-01-01'.

32. Click Manual 1099 transactions.

This form contains the list of transactions that were added manually and those that we just imported.

33. Open Voucher column filter.

34. Enter a filter value of "IMPORT-001" on the "Voucher" field using the "begins with" filter operator.

1. Close the page.

2. Close the page.

3. Go to Organization administration > Workspaces > Electronic reporting.

4. Click Reporting configurations.

5. In the tree, select '1099 Payments model'.

Assume that you want to support importing the same data but from a .TXT file format.

6. Click Create configuration to open the dialog box.

7. In the New field, enter 'Format based on data model 1099 Payments model'.

8. In the Name field, type 'Import data from TXT file'.

9. Select Yes in the Supports data import field.

10. Click Create configuration.

11. Click Designer.

12. Click Map format to model.

13. Click New.

14. In the Definition field, enter or select a value.

Select '1099-MISC' option.

15. In the Name field, type 'Import data from TXT file'.



NOTENOTE

16. In the Description field, type 'Import data from TXT file'.

17. Click Save.

18. Close the page.

19. Close the page.

20. Click Edit.

If you installed the hotfix "KB 4012871 Support of GER model mappings in separated configurations with

an ability to specify different kinds of prerequisites for deploying them on different versions of Dynamics

365 Finance" (KB 4012871), execute the next step "Turn the flag 'Default for model mapping' on" for the

entered format configuration. Skip the next step otherwise.

21. Select Yes in the Default for model-mapping field.

22. In the tree, select '1099 Payments model'.

23. Click Designer.

24. Click Map model to datasource.

25. Click Run.

If you installed the hotfix, KB 4012871 Support of GER model mappings in separated configurations with

an ability to specify different kinds of prerequisites for deploying them on different versions (KB

4012871), select the preferred model mapping in the lookup field. If you haven't installed the hotfix yet,

skip to the next step as the mapping has already been selected by the definition of the default format

configuration.

If you have not installed the hotfix, KB 4012871, notice that the dialog box contains an additional model-

mapping question that is used to parse the file that you are importing. The data is then ported from the

dialog box to the data model. Currently, you can choose which format mapping must be used depending

on the type of file that you plan to import.

If you plan to call this model mapping from a point in the application that is specifically designed for the

action, the ER destination and the format mapping must be marked as part of the integration.

26. Click Cancel.

27. Close the page.

28. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Configure data import from SharePoint
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Prerequisites

Create required ER configurationsCreate required ER configurations

ER configurationsER configurations

Sample of the incoming file for data importSample of the incoming file for data import

To import data from an incoming file by using the Electronic reporting (ER) framework, you must configure an

ER format that supports the import and then run a model mapping of the To destinationTo destination type that uses that

format as a data source. To import data, you must navigate to the file that you want to import. The incoming file

can be manually selected by user. With the new ER capability to support importing data from Microsoft

SharePoint, this process can be configured as unattended. You can use ER configurations to perform data import

from files that are stored in Microsoft SharePoint folders. This topic explains how to complete the import from

SharePoint. The examples use vendor transactions as business data.

To complete the examples in this topic, you must have the following access:

Access one of the following roles:

Electronic reporting developer

Electronic reporting functional consultant

System administrator

Access to the instance of Microsoft SharePoint Server that is configured for use with the application.

ER format and model configurations for 1099 payments.

Play the ER Impor t data from a Microsoft Excel fileER Impor t data from a Microsoft Excel file task guides, which are part of the 7.5 .4 .37.5 .4 .3

Acquire/Develop IT ser vice/solution components (10677)Acquire/Develop IT ser vice/solution components (10677)  business process. These task guides walk you

through the process of designing and using ER configurations to interactively import vendor transactions from

Microsoft Excel files. For more information, see Parse incoming documents in Excel format. After you have

completed the task guides, you will have the following setup.

ER model configuration, 1099 Payments model1099 Payments model

ER format configuration, Format for impor ting vendors' transactions from ExcelFormat for impor ting vendors' transactions from Excel

Excel file 1099impor t-data.xlsx1099impor t-data.xlsx, with vendor transactions that should be imported.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-configure-data-import-sharepoint.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/parse-incoming-documents-excel


NOTENOTE

Configure access to SharePoint for file storage

The format for importing vendor transactions is selected as the default model mapping. Therefore, if you run a model

mapping of the 1099 Payments model1099 Payments model, and that model mapping is of the To destinationTo destination type, the model mapping

runs this format to import data from external files. It then uses that data to update application tables.

To store electronic report files in a SharePoint location, you must configure access to the SharePoint Server

instance that will be used by the current company. In this example, the company is USMF. For instructions, see

Configure SharePoint storage.

1. Complete the steps in Configure SharePoint storage.

2. Open the configured SharePoint site.

3. Create the following folders where incoming electronic reporting files can be stored:

Files import source (main) (Example shown in screenshot below)

Files import source (alternative)

4. (Optional) Create the following folders where the files can be stored after import.

Files archive folder - This folder would be for successfully imported files.

Files warning folder - This folder would be for files that were imported with a warning.

Files error folder - This folder would be for files that failed to import.

5. Go to Organization administration > Document management > Document typesOrganization administration > Document management > Document types .

6. Create the following document types that will be used to access the SharePoint folders that you created.

For instructions, see Configure document types.



DO C UM EN T  T Y P EDO C UM EN T  T Y P E GRO UPGRO UP LO C AT IO NLO C AT IO N SH A REP O IN T  F O L DERSH A REP O IN T  F O L DER

SP Main File SharePoint Files import source (main)

SP Alternative File SharePoint Files import source
(alternative)

SP Archive File SharePoint Files archive folder

SP Warning File SharePoint Files warning folder

SP Error File SharePoint Files error folder

Configure ER sources for the ER format
1. Click Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > Electronic repor ting sourceElectronic repor ting source.

2. On the Electronic repor ting sourceElectronic repor ting source page, configure the source files for data import by using the

configured ER format.

3. Define a file name mask, so that only files with the .xlsx extension are imported. The file name mask is

optional and is used only when it has been defined. You can define only one mask for each ER format.

4. Change Sor t files before impor tSor t files before impor t to Do not sor tDo not sor t, if there are several files for import and the import

order is not important

5. Select all SharePoint folders that you created earlier.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/gerimportfromsharepoint-07-formatsourcesetup.png


NOTENOTE

Review the files states for the ER format

Import data from Excel files that are in a SharePoint folder

The ER source is defined for each application company individually. By contrast, ER configurations are shared across

companies.

When you delete an ER source setting for an ER format, all connected file states (see below) are also deleted by

confirmation.

1. On the Electronic repor ting sourceElectronic repor ting source page, select File states for the sourcesFile states for the sources  to review the content of

the configured file sources for the current ER format.

2. In the FilesFiles  section, review the list of files. This list presents the following:

Source files that are applicable, based on the file name mask (if a file name mask is defined), and that

are ready for data import. For these files, the Sources log for the impor t formatSources log for the impor t format section is blank.

Previously imported files. For each of these files, in the Sources log for the impor t formatSources log for the impor t format section,

you can review the history of import of this file.

You can also open the File states for the sourcesFile states for the sources  page by selecting Organization administrationOrganization administration >

Electronic repor tingElectronic repor ting > File states for the sourcesFile states for the sources . In this case, the page provides information about file

sources for all ER formats that file sources have been configured for in the company that you're currently signed

in to.

1. In SharePoint, upload the Microsoft Excel file 1099impor t-data.xlsx1099impor t-data.xlsx that contains vendor transactions

to the Files impor t source (main)Files impor t source (main)  SharePoint folder that you created earlier.

2. On the File states for the sourcesFile states for the sources  page, select RefreshRefresh to refresh the page. The Excel file that was

uploaded to SharePoint appeared on this page with the status ReadyReady . The following statuses are

currently supported:

ReadyReady  – Assigned automatically for each new file in a SharePoint folder. This status means that the file

is ready for import.

Impor tingImpor ting – Assigned automatically by an ER report when the file will be locked by the import

process to prevent its usage by other processes (if many of them are running simultaneously).

Impor tedImpor ted – Assigned automatically by an ER report when the file import is successfully completed.

This status means that the imported file has been deleted from the configured files source (SharePoint

folder).

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/gerimportfromsharepoint-08-uploadfile.png


Import data from SharePoint files

FailedFailed – Assigned automatically by an ER report when the file import completed with errors or

exceptions.

On holdOn hold – Assigned manually by user on this page. This status means that the file will not be

imported for now. This status can be used to postpone the import of some files.

1. Open the ER configurations tree, select the 1099 Payment model1099 Payment model , and expand the list of ER model

components.

2. Select the name of the model mapping to open the list of model mappings of the selected ER model

configuration.

3. Select RunRun to run the selected model mapping. Because you configured file sources for the ER format,

you can change the setting of the File sourceFile source option, if needed. If you keep the setting of this option, the

.xslx files are imported from the configured sources (the SharePoint folders, in this example).

In this example, you're importing only one file. However, if there are multiple files, they are selected for

importing in the order in which they were added to the SharePoint folder. Every run of an ER format

imports a single selected file.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/gerimportfromsharepoint-09-filestatesform.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/gerimportfromsharepoint-10-selectmodelmapping.png


4. The model mapping can run unattended in batch mode. In this case, every time that a batch runs this ER

format, a single file is imported from the configured file sources.

When a file is successfully imported from the SharePoint folder, it's deleted from that folder and moved

to folder for successful imported files or to the folder to imported files with warnings. Otherwise it's

moved to folder for failed files or stays in this folder if the folder for failed files isn't set up.

5. Enter the voucher ID, such as V-00001V-00001 , and then select OKOK.

6. On the File states for the sourcesFile states for the sources  page, select RefreshRefresh to refresh the page.

7. In the FilesFiles  section, review the list of files. The Sources log for the impor t formatSources log for the impor t format section provides

the history of the Excel file import. Because this file was successfully imported, it's marked as DeletedDeleted in

the SharePoint folder.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/gerimportfromsharepoint-11-runmodelmapping.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/gerimportfromsharepoint-12-modelmappingrunfinished.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/gerimportfromsharepoint-13-filestatesform.png


Prepare an Excel file for import

8. Review the Files impor t source (main)Files impor t source (main)  SharePoint folder. The Excel files that were successfully

imported have been deleted from this folder.

9. Select Accounts payableAccounts payable > Periodic tasksPeriodic tasks  > Tax 1099Tax 1099  > Vendor settlement for 1099sVendor settlement for 1099s .

10. In the From dateFrom date and To dateTo date fields, enter appropriate values. Then select Manual 1099 transactionsManual 1099 transactions .

The vendor transactions that were imported from the Excel files on SharePoint for voucher V-00001V-00001 , are

presented on the page.

1. Open the Excel file that you previously used. In row 3 column 1, add a vendor code that doesn't exist in

the application. Add additional false vendor information to the row.

2. Upload the updated Excel file that contains vendors transactions to the Files impor t source (main)Files impor t source (main)

SharePoint folder.

3. Open the ER configurations tree, select the 1099 Payment model1099 Payment model , and expand the list of ER model

components.

4. Select the name of the model mapping to update the model mapping so that the incorrect vendor code is

considered an error during the data import process.

5. Select DesignerDesigner .

6. On the ValidationsValidations  tab, you must change the post-validation action for the validation rule that was

configured to evaluate whether the vendor account that is imported exists in the application. Update the

value of the Post-validation actionPost-validation action field to Stop executionStop execution, save your changes, and close the page.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/gerimportfromsharepoint-14-importedtransactions.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/gerimportfromsharepoint-15-excel.png


7. Save your changes, and close the ER model mapping designer.

8. Select RunRun to run the modified ER model mapping.

9. Enter the voucher ID, such as V-00002V-00002 , and then select OKOK.

The Infolog contains a notification that there's a file in the SharePoint folder that contains incorrect

vendor account and can’t be imported.

10. On the File states for the sourcesFile states for the sources  page, select RefreshRefresh, and then, in the FilesFiles  section, review the list of

files.

The Sources log for the impor t formatSources log for the impor t format section indicates that the import process failed and that the file is in

the Files error SharePoint folder (the Is deletedIs deleted check box is not selected). If you fix this file on SharePoint by

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/gerimportfromsharepoint-16-updatemodelmapping.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/gerimportfromsharepoint-17-modelmappingrunfinished.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/gerimportfromsharepoint-18-filestatesform.png


 Limitations

Additional resources

NOTENOTE

adding the proper vendor code and then move it to the Files import source (main) SharePoint folder, you can

import the file again.

11. Select Accounts payableAccounts payable > Periodic tasksPeriodic tasks  > Tax 1099Tax 1099  > Vendor settlement for 1099sVendor settlement for 1099s , enter

appropriate values in the From dateFrom date and To dateTo date fields, and then select Manual 1099 transactionsManual 1099 transactions .

Only transactions for voucher V-00001 are available. No transactions for voucher V-00002 are available

even though the error for the last imported transaction has been found in the Excel file.

The ER framework doesn't offer the capability to initiate a new batch job that will execute a model mapping in

unattended mode for data import. To do this, you must develop new logic so that the configured ER model

mapping can be called from the application user interface (UI) to import data from inbound files. Therefore,

some engineering work is required.

To learn more about the relevant ER API, see the Code to run a format mapping for data import section in the ER

framework API changes for Application update 7.3 topic.

Review the code in the BankImport_RU  class of the Application Suite  model to see how your custom logic can

be implemented. This class extends the RunBaseBatch  class. In particular, review the runER()  method where the 

ERIModelMappingDestinationRun  object is created as the runner of an ER model mapping.

Electronic Reporting overview

ER framework API changes for Application update 7.3

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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C O N T EN T  DESC RIP T IO NC O N T EN T  DESC RIP T IO N F IL EF IL E

Sample file in XML format IncomingDocumentToLearnHowToHandleOptionalAttributes.
xml

Task guide RCS Import files in XML format with optional attributes.axtr

Create a new data model configuration

You can design Electronic reporting (ER) formats to parse incoming electronic documents in XML format.

Certain attributes of XML elements can be specified in designed ER format as optional. It will allow you to

handle incoming files with and without such XML attributes properly. You can then use the content from these

files to update application data.

To learn more about this feature, complete the steps in the topic, (RCS) Import files in XML format with optional

attributes, which is part of the 7.5.4.3 Acquire/Develop IT service/solution components (10677) business

process. You can download this task guide and associated sample files from the Microsoft Download Center.

The following steps explain how a user in the System Administrator or Electronic Reporting Developer role can

design ER format configuration to import files in XML format containing optional attributes. To complete these

steps, you must first complete the steps in the procedure, Create configuration providers and mark them as

active. Before you begin, download and save locally the

IncomingDocumentToLearnHowToHandleOptionalAttributes.xml file from Microsoft Download Center

(https://go.microsoft.com/fwlink/?linkid=874684 ).

1. Go to Organization administrationOrganization administration > WorkspacesWorkspaces  > Electronic repor tingElectronic repor ting.

2. Make sure that the configuration provider for the sample company, Litware, Inc., is available and marked as

ActiveActive. If you don't see this configuration provider, complete the steps in the topic, Create configuration

providers and mark them as active.

3. Click Repor ting configurationsRepor ting configurations .

1. Click Create configurationCreate configuration to open the drop dialog.

2. In the NameName field, type 'Model to import xml file'.

3. Click Create configurationCreate configuration.

4. Click DesignerDesigner .

5. Click NewNew  to open the drop dialog.

6. In the NameName field, type 'Root'.

7. Click AddAdd.

8. Click NewNew  to open the drop dialog.

9. In the NameName field, type 'List'.

10. In the Item typeItem type field, select Record listRecord list.

11. Click AddAdd.

12. Click NewNew  to open the drop dialog.

13. In the NameName field, type 'Code'.

14. In the Item typeItem type field, select Str ingStr ing.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/rcs-optional-attributes.md
https://go.microsoft.com/fwlink/?linkid=874684
https://go.microsoft.com/fwlink/?linkid=874684


Create a format for data import

Design a format to parse incoming file in xml format

Design a format mapping to save parsed information to data model

15. Click AddAdd.

16. Click SaveSave.

17. Close the page.

18. Click Change statusChange status .

19. Click CompleteComplete.

20. Click OKOK.

1. Click Create configurationCreate configuration to open the drop dialog.

2. In the NewNew  field, enter 'Format based on data model Model to import xml file'.

3. In the NamName field, type 'Format to import xml file'.

4. Select YesYes  in the Suppor ts data impor tSuppor ts data impor t field.

5. Click Create configurationCreate configuration.

1. Click DesignerDesigner .

2. Click Add rootAdd root to open the drop dialog.

3. In the tree, select XML\ElementXML\Element.

4. In the NameName field, type 'root'.

5. Click OKOK.

6. Click AddAdd to open the drop dialog.

7. In the tree, select XML\ElementXML\Element.

8. In the NameName field, type 'document'.

9. In the MultiplicityMultiplicity  field, select One manyOne many .

10. Click OKOK.

11. In the tree, select root\documentroot\document.

12. Click AddAdd to open the drop dialog.

13. In the tree, select XML\Attr ibuteXML\Attr ibute.

14. In the NameName field, type 'id'.

15. Click OKOK.

16. Click SaveSave.

1. Click Map format to modelMap format to model .

2. Click NewNew .

3. In the DefinitionDefinition field, enter or select a value.

4. In the NameName field, type 'Mapping'.

5. Click SaveSave.

6. Click DesignerDesigner .

7. In the tree, expand formatformat.

8. In the tree, expand format\root: XML Element(root)format\root: XML Element(root) .

9. In the tree, select *format\root: XML Element(root)\document: XML Element 1.. (document)**.

10. Click BindBind.

11. In the tree, expand *format\root: XML Element(root)\document: XML Element 1.. (document)**.

12. In the tree, select format\root: XML Element(root)\document: XML Element 1.. (document)\id*.



Run format mapping

NOTENOTE

Modify format structure to handle xml attribute as optional

Run format mapping to test changes

NOTENOTE

13. In the tree, expand L ist = format.root.documentList = format.root.document.

14. In the tree, select L ist = format.root.document\CodeList = format.root.document\Code.

15. Click BindBind.

16. Click SaveSave.

17. Close the page.

1. Click RunRun.

2. Click BrowseBrowse and select the file, IncomingDocumentToLearnHowToHandleOptionalAttr ibutes.xmlIncomingDocumentToLearnHowToHandleOptionalAttr ibutes.xml .

3. Click OKOK.

The selected file has not been imported as the format design assumes the existence of 'id' attribute for the 'document'

element, but the imported file contains no such attribute.

1. Close the page.

2. In the tree, expand root\documentroot\document.

3. In the tree, select root\document\idroot\document\id.

4. In the Empty str ing for missing attr ibuteEmpty str ing for missing attr ibute field, select YesYes .

5. Click SaveSave.

1. Click Map format to modelMap format to model .

2. Click RunRun.

3. Click BrowseBrowse and select the file, IncomingDocumentToLearnHowToHandleOptionalAttr ibutes.xmlIncomingDocumentToLearnHowToHandleOptionalAttr ibutes.xml .

4. Click OKOK.

5. Review the generated file. Note that same file has been imported as the format design now consider the 'id'

attribute for the 'document' element as optional.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Create a new data model configuration

Create a format for data import

The following steps explain how a user in the System Administrator or Electronic Reporting Developer role can

design ER format configuration to import files in XML format containing optional attributes. To complete these

steps, you must first complete the steps in the "Create a configuration provider and mark it as active" procedure.

Before you begin, download and save locally the

IncomingDocumentToLearnHowToHandleOptionalAttributes.xml file from Microsoft Download Center.

1. Go to All workspacesAll workspaces  > Electronic repor tingElectronic repor ting.

2. Make sure that the configuration provider for the sample company, Litware, Inc., is available and marked as

ActiveActive. If you don't see this configuration provider, complete the steps in the procedure Create configuration

providers and mark them as active.

3. Click Repor ting configurationsRepor ting configurations .

1. Click Create configurationCreate configuration to open the drop dialog.

2. In the NameName field, type 'Model to import xml file'.

3. Click Create configurationCreate configuration.

4. Click DesignerDesigner .

5. Click NewNew  to open the drop dialog.

6. In the NameName field, type 'Root'.

7. Click AddAdd.

8. Click NewNew  to open the drop dialog.

9. In the NameName field, type 'List'.

10. In the Item typeItem type field, select Record listRecord list.

11. Click AddAdd.

12. Click NewNew  to open the drop dialog.

13. In the NameName field, type 'Code'.

14. In the Item typeItem type field, select Str ingStr ing.

15. Click AddAdd.

16. Click SaveSave.

17. Close the page.

18. Click Change statusChange status .

19. Click CompleteComplete.

20. Click OKOK.

1. Click Create configurationCreate configuration to open the drop dialog.

2. In the NewNew  field, enter 'Format based on data model Model to import xml file'.

3. In the NameName field, type 'Format to import xml file'.

4. Select YesYes  in the Suppor ts data impor tSuppor ts data impor t field.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/import-files-xml-format-optional-attributes.md
https://go.microsoft.com/fwlink/?linkid=874684


Design a format to parse incoming file in xml format

Design a format mapping to save parsed information to data model

Run format mapping

5. Click Create configurationCreate configuration.

1. Click DesignerDesigner .

2. Click Add rootAdd root to open the drop dialog.

3. In the tree, select XML\ElementXML\Element.

4. In the NameName field, type 'root'.

5. Click OKOK.

6. Click AddAdd to open the drop dialog.

7. In the tree, select XML\ElementXML\Element.

8. In the NameName field, type 'document'.

9. In the MultiplicityMultiplicity  field, select One manyOne many .

10. Click OKOK.

11. In the tree, select root\documentroot\document.

12. Click AddAdd to open the drop dialog.

13. In the tree, select XML\Attr ibuteXML\Attr ibute.

14. In the NameName field, type 'ID'.

15. Click OKOK.

16. Click SaveSave.

1. Click Map format to modelMap format to model .

2. Click NewNew .

3. In the DefinitionDefinition field, enter or select a value.

4. In the list, click the link in the selected row.

5. In the NameName field, type 'Mapping'.

6. Click SaveSave.

7. Click DesignerDesigner .

8. In the tree, expand formatformat.

9. In the tree, expand format\root: XML Element(root)format\root: XML Element(root) .

10. In the tree, select *format\root: XML Element(root)\document: XML Element 1.. (document)**.

11. Click BindBind.

12. In the tree, expand *format\root: XML Element(root)\document: XML Element 1.. (document)**.

13. In the tree, select format\root: XML Element(root)\document: XML Element 1.. (document)\id*.

14. In the tree, expand L ist = format.root.documentList = format.root.document.

15. In the tree, select L ist = format.root.document\CodeList = format.root.document\Code.

16. Click BindBind.

17. Click SaveSave.

18. Close the page.

1. Click RunRun.

2. Click BrowseBrowse and select IncomingDocumentToLearnHowToHandleOptionalAttr ibutes.xmlIncomingDocumentToLearnHowToHandleOptionalAttr ibutes.xml .

3. Click OKOK.



NOTENOTE

Modify format structure to handle xml attribute as optional

Run format mapping to test changes

NOTENOTE

NOTENOTE

The selected file has not been imported as the format design assumes the existence of 'id' attribute for the 'document'

element, but the imported file contains no such attribute.

1. Close the page.

2. In the tree, expand root\documentroot\document.

3. In the tree, select root\document\idroot\document\id.

4. Select YesYes  in the Empty str ing for missing attr ibuteEmpty str ing for missing attr ibute field.

5. Click SaveSave.

1. Click Map format to modelMap format to model .

2. Click RunRun.

3. Click BrowseBrowse and select the IncomingDocumentToLearnHowToHandleOptionalAttr ibutes.xmlIncomingDocumentToLearnHowToHandleOptionalAttr ibutes.xml  file.

4. Click OKOK.

5. Review the generated file.

The same file has been imported as the format design now consider the 'id' attribute for the 'document' element as

optional.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Additional resources

You can design Electronic reporting (ER) formats to generate outgoing documents in XML format. Sometimes,

those documents can be accepted only when they meet specific criteria, such a maximum file size or a maximum

number of some XML nodes. You can design ER formats to generate electronic documents that satisfy the

requirements that the recipients of those documents specify.

For the FILE format element, you can define a limit on the file size as an ER expression. If the defined limit is

exceeded when an ER report is generated, ER finishes creating the current file and then moves on to create

the next file.

For any XML ELEMENT format, you can define a limit on the number of elements as an ER expression. If the

number of XML nodes in the file that is generated exceeds the defined limit when an ER report is run, ER

finishes creating the current file and then moves on to create the next file.

For any XML SEQUENCE format element, you can define a limit on the number of child elements as an ER

expression. If the number of nested XML nodes of the format element in the generated file exceeds the

defined limit when an ER report is run, ER finishes creating the current file and then moves on to create the

next file.

You can mark any XML ELEMENT format element as non-breakable. In this way, you can keep the nested

items of XML nodes that are generated under the format element in a single generated file.

In addition to using the XML ELEMENT and XML SEQUENCE format elements to add XML nodes to the

generated file, you can use the RAW XML format element. However, nodes that you add by using the RAW XML

format element aren't considered when the number of nodes is calculated to evaluate the limits on the number

of elements.

If you configured file destinations for a FILE format element that has been configured to split the generated

output whenever specific limits are exceeded, each piece of generated output is sent to the configured file

destination as an individual file. To uniquely name the files that are created by splitting the output, you must

configure an ER expression for the FILE format element. If you include an ER data source of the NUMBER

SEQUENCE type, the number sequence will be incremented for each piece of the split output.

To learn more about this feature, play the ER Split XML files based on the file size or content itemER Split XML files based on the file size or content item

quantityquantity  task guide, which is part of the 7.5 .4 .3 Acquire/Develop IT ser vice/solution components7.5 .4 .3 Acquire/Develop IT ser vice/solution components

(10677)(10677)  business process and can be downloaded from the Microsoft Download Center. This task guide walks

you through the process of configuring an ER format to split generated files based on limits on the file size and

content item quantity. To complete the task guide, you must download the following files:

ER model configuration - XmlFilesSplittingModel.xml

ER format configuration - XmlFilesSplittingFormat.xml

Electronic reporting (ER) destinations

Formula designer in Electronic reporting (ER)

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-split-files.md
https://go.microsoft.com/fwlink/?linkid=874684
https://go.microsoft.com/fwlink/?linkid=874111
https://go.microsoft.com/fwlink/?linkid=874111
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Support parameterized calls of ER data sources of
the Calculated field type
2/18/2021 • 10 minutes to read • Edit Online

Prerequisites

C O N T EN TC O N T EN T F IL E  N A M EF IL E  N A M E

Sample ER data model configuration Model to learn parameterized calls.version.1.xml

Sample ER metadata configuration Metadata to learn parameterized calls.version.1.xml

Sample ER model mapping configuration Mapping to learn parameterized calls.version.1.1.xml

Sample ER format configuration Format to learn parameterized calls.version.1.1.xml

Sign in to your RCS instance

This topic explains how you can design an Electronic reporting (ER) data source by using the Calculated fieldCalculated field

type. This data source may contain an ER expression that, when executed, can be controlled by the values of the

parameter arguments that are configured in a binding that calls this data source. By configuring parameterized

calls of such a data source, you can reuse a single data source in many bindings, which reduces the total number

of data sources that must be configured in ER model mappings or ER formats. It also simplifies the configured

ER component, which reduces the maintenance costs and the cost of use by other consumers.

To complete the examples in this topic, you must have the following access:

Access to one of these roles:

Electronic reporting developer

Electronic reporting functional consultant

System administrator

Access to Regulatory Configuration Services (RCS) that have been provisioned for the same tenant as

Finance and Operations for one of the following roles:

Electronic reporting developer

Electronic reporting functional consultant

System administrator

You must also download and locally store the following files.

In this example, you will create a configuration for the sample company, Litware, Inc. First, in RCS, you must

complete the steps in the Create configuration providers and mark them as active procedure:

1. On the default dashboard, select Electronic repor tingElectronic repor ting.

2. Select Repor ting configurationsRepor ting configurations .

3. Import the downloaded configurations to RCS in the following sequence: data model, metadata, model

mapping, format. Complete the following steps for each ER configuration:

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-calculated-field-type.md
https://mbs.microsoft.com/customersource/global/AX/downloads/hot-fixes/365optelecrepeg
https://mbs.microsoft.com/customersource/global/AX/downloads/hot-fixes/365optelecrepeg
https://mbs.microsoft.com/customersource/global/AX/downloads/hot-fixes/365optelecrepeg
https://mbs.microsoft.com/customersource/global/AX/downloads/hot-fixes/365optelecrepeg


Review the provided ER solution
Review model mappingReview model mapping

Review formatReview format

a. Select Exchange.Exchange.

b. Select Load from XML fileLoad from XML file.

c. Select BrowseBrowse, and then select the required ER configuration in XML format.

d. Select OK.OK.

1. In the configuration tree, expand the content of the Model to learn parameter ized callsModel to learn parameter ized calls  item.

2. Select Mapping to learn parameter ized callsMapping to learn parameter ized calls .

3. Select DesignerDesigner .

4. Select DesignerDesigner .

This ER model mapping is designed to do the following:

Fetch the list of tax codes (TaxTax data source) residing in the TaxTableTaxTable table.

Fetch the list of tax transactions (TransTrans  data source) residing in the TaxTransTaxTrans  table:

Group the list of fetched transactions (GrGr  data source) by tax code.

Calculate for grouped transactions following aggregated values per tax code:

Sum of tax base values.

Sum of tax values.

Minimum value of applied tax rate.

The model mapping in this configuration implements the base data model for any of the ER formats

created for this model and executed in Finance and Operations. As a result, the content of the TaxTax and GrGr

data sources is exposed for ER formats such as abstract data sources.

5. Close the Model mapping designerModel mapping designer  page.

6. Close the Model mappingModel mapping page.

1. In the configuration tree, expand the content of the Model to learn parameter ized callsModel to learn parameter ized calls  item.

2. Select Format to learn parameter ized callsFormat to learn parameter ized calls .

3. Select DesignerDesigner . This ER format is designed to do the following:



Generate a tax statement in XML format.

Present the following levels of taxation in the tax statement: regular, reduced, and none.

Present multiple details at each taxation level, having a different number of details in each level.

4. Select MappingMapping.

5. Expand the ModelModel , Data,Data, and Summar ySummar y  items.

The calculated field Model.Data.Summar y.LevelModel.Data.Summar y.Level  contains the expression that returns the code of the

taxation level (RegularRegular , ReducedReduced, None,None, or OtherOther ) as a text value for any tax code that can be retrieved

from the Model.Data.Summar yModel.Data.Summar y  data source at run time.

6. Expand the ModelModel .Data2Data2  item.

7. Expand the ModelModel .Data2.Summar y2Data2.Summar y2  item.

The ModelModel .Data2.Summar y2Data2.Summar y2  data source is configured to group the Model.Data.Summar yModel.Data.Summar y  data

source transaction details by taxation level (returned by the Model.Data.Summar y.LevelModel.Data.Summar y.Level  calculated

field) and compute the aggregations.



Create a derived format

Configure a parameterized calculated field that returns a list of
records
Start adding a new calculated fieldStart adding a new calculated field

Define a parameter for adding a calculated fieldDefine a parameter for adding a calculated field

8. Review the calculated fields ModelModel .Data2.Level1Data2.Level1 , ModelModel .Data2.Level2Data2.Level2 , and ModelModel .Data2.Level3.Data2.Level3.

These calculated fields are used to filter the ModelModel .Data2.Summar y2Data2.Summar y2  records list and return only

records that represent a particular taxation level.

9. Close the Format designerFormat designer  page.

You can improve the provided format by adding one calculated field to filter the required taxation level instead

of using the existing three fields: ModelModel .Data2.Level1Data2.Level1 , ModelModel .Data2.Level2,Data2.Level2, and ModelModel .Data2.Level3Data2.Level3 . The

required taxation level can be specified in the location where this new calculated field will be called.

1. In the configuration tree, expand the content of the Model to learn parameter ized callsModel to learn parameter ized calls  item.

2. Select Format to learn parameter ized callsFormat to learn parameter ized calls .

3. Select Create configurationCreate configuration.

4. Select Derive from Name: Format to learn parameter ized calls , MicrosoftDerive from Name: Format to learn parameter ized calls , Microsoft.

5. In the NameName field, enter Format to learn parameter ized calls (custom)Format to learn parameter ized calls (custom) .

6. Select Create configuration.Create configuration.

1. Select DesignerDesigner .

2. Select Expand/collapseExpand/collapse to expand all format items.

3. Select MappingMapping.

4. Expand the ModelModel  item.

5. Select the Model.Data2Model.Data2  item.

6. Select AddAdd.

7. Select Functions\Calculated fieldFunctions\Calculated field.

8. In the NameName field, enter LevelsLevels .

9. Select Edit formulaEdit formula.

1. Select ParametersParameters .



Define an expression for adding a calculated fieldDefine an expression for adding a calculated field

2. Select NewNew .

3. In the NameName field, enter Taxation LevelTaxation Level .

4. In the TypeType field, select Str ingStr ing.

Only primitive data types can be used to specify the type of the parameter ’s argument. Therefore, RecordRecord

listlist, RecordRecord, and EnumEnum types cannot be used for this purpose.

The maximum number of parameters that can be specified for a single calculated field is 8.

5. Select OKOK.

By adding this parameter, you specify the condition that must be in place to call this calculated field. When you

call this calculated field, you need to specify the argument of the Taxation LevelTaxation Level  parameter as a value with

Str ingStr ing format.

Make sure that you define parameters only for those calculated fields that reside in a container (either RecordRecord

listlist, RecordRecord, or ContainerContainer ).

The configured parameter is available in the list of data sources for this calculated field. You can add the

parameter to the configured expression by selecting Add data sourceAdd data source.

1. In the FormulaFormula field, enter :

WHERE(@.Summar y2, @.Summar y2.grouped.Level =WHERE(@.Summar y2, @.Summar y2.grouped.Level =



Finish adding a new calculated fieldFinish adding a new calculated field

Use the configured calculated field for binding format elementsUse the configured calculated field for binding format elements

2. Select the Taxation LevelTaxation Level  parameter in the list of data sources.

3. Select Add data sourceAdd data source.

4. In the FormulaFormula field, finalize the expression as:

WHERE(@.Summar y2, @.Summar y2.grouped.Level = 'Taxation Level')WHERE(@.Summar y2, @.Summar y2.grouped.Level = 'Taxation Level')

5. Select SaveSave.

6. Close the Formula designerFormula designer  page.

Select OKOK.

On the Format designerFormat designer  page, the configured parameterized calculated field LevelsLevels  requires a Str ingStr ing

argument.

1. Select Model.Data2.LevelsModel.Data2.Levels  to select the configured calculated field.

2. Select the Statement.Taxation.RegularStatement.Taxation.Regular  format element.

3. Select BindBind.

4. Select YesYes  to confirm the replacement of the currently used data source, Level1Level1 , by the new data source,

LevelsLevels , in all nested format elements of the selected format element.



Configure a parameterized calculated field to return a record

Applied binding has been built as a call of the parameterized calculated field. By default, the name of the

bound format element is used as an argument for parameterized calculated field under the following

conditions:

The calculated field is configured to use a single parameter.

The data type of this parameter is defined as Str ingStr ing.

When the name of the bound format element is blank, the data source name of this element is used in

applied binding.

5. Select the Statement.Taxation.ReducedStatement.Taxation.Reduced format element.

6. Select BindBind.

7. Select YesYes  to confirm the replacement of the currently used data source, Level2Level2 , by the new data source,

LevelsLevels , in all nested format elements under the selected format element.

8. Select the Statement.Taxation.NoneStatement.Taxation.None format element.

9. Select BindBind.

10. Select YesYes  to confirm the replacement of the currently used data source, Level3Level3 , by the new data source,

LevelsLevels , in all nested format elements under the selected format element.

When you specify the argument of the parameterized calculated field for the XML element representing taxation

level (for example, Model.Data2.Levels("Reduced")Model.Data2.Levels("Reduced")  as a text value), you don’t need to do the same for nested

XML attributes—their bindings will automatically inherit the value of the argument defined on the parent level

(Model.Data2.Levels.aggregated.BaseModel.Data2.Levels.aggregated.Base, not Model.Data2.Levels("Reduced").aggregated.BaseModel.Data2.Levels("Reduced").aggregated.Base).

Recurrent calls of any parameterized calculated field are not supported.

You can select Edit formulaEdit formula, and change the applied-by-default argument of the parameterized calculated field

in the selected binding. If this argument is missing, it can cause errors at run time — users are informed about

such a situation when the current format is validated.

When a parameterized calculated field returns a record, you need to support binding of individual fields of this

record to format elements. In such cases there will be no parent binding that contains the value of an argument



Start adding a new calculated fieldStart adding a new calculated field

Define a parameter for adding a calculated fieldDefine a parameter for adding a calculated field

Define an expression for adding a calculated fieldDefine an expression for adding a calculated field

Finish adding a new calculated fieldFinish adding a new calculated field

Use the configured calculated field to bind format elementsUse the configured calculated field to bind format elements

to call a parameterized calculated field — this value must be defined in the binding of a single record’s field.

1. Select the Model.Data2Model.Data2  item.

2. Select AddAdd.

3. Select Functions\Calculated fieldFunctions\Calculated field.

4. In the NameName field, enter LevelRecordLevelRecord.

5. Select Edit formulaEdit formula.

1. Select ParametersParameters .

2. Select NewNew .

3. In the NameName field, enter Taxation LevelTaxation Level .

4. In the TypeType field, select Str ingStr ing.

5. Select OKOK.

1. In the FormulaFormula field, enter the following:

FIRSTORNULL(@.Levels(FIRSTORNULL(@.Levels(

2. Select the Taxation LevelTaxation Level  parameter.

3. Select Add data sourceAdd data source.

4. In the FormulaFormula field, append 'Taxation Level'))'Taxation Level'))  to what you entered in Step 1 to finalize the expression

to:

FIRSTORNULL(@.Levels('Taxation Level'))FIRSTORNULL(@.Levels('Taxation Level'))

5. Select SaveSave.

6. Close the Formula designerthe Formula designer  page.

Select OKOK.

1. Expand Model.Data2.LevelRecordModel.Data2.LevelRecord to select the configured calculated field.

2. Expand the Model.Data2.LevelRecord.aggregatedModel.Data2.LevelRecord.aggregated container of the configured calculated field.

3. Select the Model.Data2.LevelRecord.aggregated.BaseModel.Data2.LevelRecord.aggregated.Base field.

4. Select the Statement.Taxation.NoneStatement.Taxation.None format element.

5. Select UnbindUnbind.

6. Select the Statement.Taxation.None.BaseStatement.Taxation.None.Base format element.

7. Select BindBind.

8. Select Edit formulaEdit formula.

9. Change the expression to Model.Data2.LevelRecord("None").aggregated.BaseModel.Data2.LevelRecord("None").aggregated.Base.



Remove calculated fields that are not used
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Complete adjusted version of a derived format

Export completed version of a derived format

Test ER formats

1. Select Model.Data2.Level1Model.Data2.Level1 .

2. Select DeleteDelete.

3. Select Model.Data2.Level2Model.Data2.Level2 .

4. Select DeleteDelete.

5. Select Model.Data2.Level3Model.Data2.Level3 .

6. Select DeleteDelete.

7. Select SaveSave.

You reused the same calculated field Model.Data2.LevelsModel.Data2.Levels  several times in format bindings. It is much easier to use and

maintain a single calculated field instead of doing this for multiple similar fields.

8. Close the Format designerFormat designer  page.

1. In the VersionsVersions  FastTab, select Change statusChange status .

2. Select CompleteComplete.

1. Select Format to learn parameter ized calls (custom)Format to learn parameter ized calls (custom) format in the configurations tree.

2. In the VersionsVersions  FastTab, select the completed version 1.1.1.

3. Select ExchangeExchange.

4. Select Expor t as XML fileExpor t as XML file.

5. Store the downloaded configuration locally, in XML format.



Import ER configurationsImport ER configurations

Run ER formatsRun ER formats

Additional resources
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You can run the initial and improved ER formats to make sure that configured parameterized calculated fields

work properly.

You can import reviewed configurations from RCS by using the ER repository of the RCSRCS  type. If you already

went through the steps in the topic, Import Electronic reporting (ER) configurations from Regulatory

Configuration Services (RCS), use the configured ER repository to import configurations discussed earlier in this

topic to your environment. Otherwise, follow these steps:

1. Select the DEMFDEMF company and on the default dashboard, select Electronic repor tingElectronic repor ting.

2. Select Repor ting configurationsRepor ting configurations .

3. Import the configurations from Microsoft Download Center in the following sequence: data model, model

mapping, format. Complete the following steps for each ER configuration:

a. Select Exchange.Exchange.

b. Select Load from XML fileLoad from XML file.

c. Select BrowseBrowse to select the required ER configuration in XML format.

d. Select OKOK.

4. Import the exported from RCS completed version 1.1.1 of the Format to learn parameter ized callsFormat to learn parameter ized calls

(custom)(custom) format:

a. Select Exchange.Exchange.

b. Select Load from XML fileLoad from XML file.

c. Select BrowseBrowse to select the locally stored Format to learn parameter ized calls (custom)Format to learn parameter ized calls (custom) file in

XML format.

d. Select OKOK.

1. In the configuration tree, expand the content of the Model to learn parameter ized callsModel to learn parameter ized calls  item.

2. Select Format to learn parameter ized callsFormat to learn parameter ized calls .

3. Select RunRun on the top-most ribbon.

4. Save the locally generated output.

5. Select the Format to learn parameter ized calls (custom)Format to learn parameter ized calls (custom) item.

6. Select RunRun on the top-most ribbon.

7. Save the generated output locally.

8. Compare the contents of the generated outputs.

Formula designer in Electronic reporting (ER)

Improve performance of ER solutions by adding parameterized CALCULATED FIELD data sources

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Overview

Concepts

This topic describes how to manage the lifecycle of Electronic reporting (ER) configurations for Microsoft

Dynamics 365 Finance.

Electronic reporting (ER) is an engine that supports statutory required and country-specific electronic

documents. In general, ER assumes an ability to perform the following tasks for a single electronic document.

For more details, see Electronic reporting (ER) overview.

Design a template for an electronic document:

Identify the required sources of data that can be presented in the document:

Underlying data, such as data tables, data entities, and classes.

Process-specific properties, such as execution date and time, and time zone.

User input parameters, specified by the end user at run time.

Define the required document elements and their topology to specify a final document format.

Configure the desired flow of data from selected data sources to defined document elements (via

data source bindings to document format components), and specify process control logic.

Make a template available so that it can be used in other instances:

Transform a document template that was created into an ER configuration, and export the

configuration from the current application instance as an XML package that can be stored either

locally or in LCS.

Transform an ER configuration into an application document template.

Import an XML package that is stored either locally or in LCS into the current instance.

Customize the template of an electronic document:

Bring a template from LCS into the current instance as an ER configuration.

Design a custom version of an ER configuration, and keep a reference to the base version.

Integrate a template with a particular business process, so that it's available in the application:

Configure settings so that the application starts to use an ER configuration, by referring to that

configuration in a process-related parameter. For example, refer to the ER configuration in a specific

Accounts payable payment method to generate an electronic payment message for processing

invoices.

Use a template in a specific business process:

Run an ER configuration in a specific business process. For example, to generate an electronic

payment message for processing invoices when a payment method that references the ER

configuration is selected.

The following roles and related activities are associated with the ER configuration lifecycle.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/general-electronic-reporting-manage-configuration-lifecycle.md
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Electronic reporting functional
consultant

Create and manage ER components
(models and formats).

A business person who designs ER
domain–specific data models, designs
the required templates for electronic
documents, and binds them
accordingly.

Electronic reporting developer Create and manage data model
mappings.

A specialist who selects the required
Finance data sources and binds them
to ER domain–specific data models.

Accounting supervisor Configure process-related settings that
reference ER artifacts.

For example, an AccountingAccounting
super visorsuper visor  role that allows the
settings of an ER configuration to be
used in a particular Accounts payable
payment method to generate an
electronic payment message for
processing invoices.

Accounts payable payments clerk Use ER artifacts in a specific business
process.

For example, an Accounts payableAccounts payable
payments clerkpayments clerk role that allows
electronic payment messages to be
generated for processing invoices,
based on the ER format that is
configured for a specific payment
method.

ER configuration development lifecycle
For the following ER-related reasons, we recommend that you design ER configurations in the development

environment, as a separate instance of Finance and Operations:

Users in either the Electronic repor ting developerElectronic repor ting developer  role or the Electronic repor ting functionalElectronic repor ting functional

consultantconsultant role can edit configurations and run them for testing purposes. This scenario can cause calls of

methods of classes and tables that might harm business data and the performance of the instance.

Calls of methods of classes and tables as ER data sources of ER configurations aren't restricted by entry

points and logged company content. Therefore, users in either the Electronic repor ting developerElectronic repor ting developer  role or

the Electronic repor ting functional consultantElectronic repor ting functional consultant role can access business-sensitive data.

ER configurations that are designed in the development environment can be uploaded to the test environment

for the configuration evaluation (proper process integration, correctness of results, and performance) and

quality assurance, such as correctness of role-driven access rights and segregation of duties. The features that

enable ER configuration interchange can be used for this purpose. Finally, proven ER configurations can be

uploaded either to LCS, where they can be shared with service subscribers, or to the production environment for

internal use, such as shown in the following illustration.



Additional resources

NOTENOTE

Electronic reporting (ER) overview

Can you tell us about your documentation language preferences? Take a short survey.
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Create a new data model configuration

This topic explains how a user in the System administrator or Electronic reporting developer role can create a

new Electronic reporting (ER) configuration and upload it into the project-level Asset library in Microsoft

Dynamics Lifecycle Services (LCS).

In this example, you will create a configuration and upload it into LCS for a sample company that is named

Litware, Inc. These steps can be completed in any company, because ER configurations are shared among

companies. To complete these steps, you must first complete the steps in Create configuration providers and

mark them as active. Access to LCS is also required.

1. Sign in to the application by using one of the following roles:

Electronic reporting developer

System administrator

2. Go to Organization administrationOrganization administration > WorkspacesWorkspaces  > Electronic repor tingElectronic repor ting.

3. Select L itware, Inc.L itware, Inc., and mark it as ActiveActive.

4. Select ConfigurationsConfigurations .

  

Make sure that the current Dynamics 365 Finance user is a member of the LCS project that contains the Asset library that

is used to import ER configurations.

You can't access an LCS project from an ER repository that represents a different domain than the domain that is used in

Finance. If you try, an empty list of LCS projects will be shown, and you won't be able to import ER configurations from

the project-level Asset library in LCS. To access project-level Asset libraries from an ER repository that is used to import ER

configurations, sign in to Finance by using the credentials of a user who belongs to the tenant (domain) that the current

Finance instance has been provisioned for.

1. Go to Organization administration > Electronic repor ting > ConfigurationsOrganization administration > Electronic repor ting > Configurations .

2. On the ConfigurationsConfigurations  page, select Create configurationCreate configuration to open the drop-down dialog box.

In this example, you will create a configuration that contains a sample data model for electronic

documents. This data model configuration will be uploaded into LCS later.

3. In the NameName field, enter Sample model configurationSample model configuration.

4. In the Descr iptionDescr iption field, enter Sample model configurationSample model configuration.

5. Select Create configurationCreate configuration.

6. Select Model designerModel designer .

7. Select NewNew .

8. In the NameName field, enter Entr y pointEntr y point.

9. Select AddAdd.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-upload-configuration-into-lifecycle-services.md
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Register a new repository

Upload a configuration into LCS

10. Select SaveSave.

11. Close the page.

12. Select Change statusChange status .

13. Select CompleteComplete.

14. Select OKOK.

15. Close the page.

1. Go to Organization administration > Workspaces > Electronic repor tingOrganization administration > Workspaces > Electronic repor ting.

2. In the Configuration providersConfiguration providers  section, select the L itware, Inc.L itware, Inc. tile.

3. On the L itware, Inc.L itware, Inc. tile, select Repositor iesRepositor ies .

You can now open the list of repositories for the Litware, Inc. configuration provider.

4. Select AddAdd to open the drop-down dialog box.

You can now add a new repository.

5. In the Configuration repositor y enterConfiguration repositor y enter  field, select LCSLCS .

6. Select Create repositor yCreate repositor y .

7. In the ProjectProject field, enter or select a value.

For this example, select the desired LCS project. You must have access to the project.

8. Select OKOK.

Complete a new repository entry.

9. In the list, mark the selected row.

For this example, select the LCSLCS  repository record.

Note that a registered repository is marked by the current provider. In other words, only configurations

that are owned by that provider can be put in this repository and therefore uploaded into the selected

LCS project.

10. Select OpenOpen.

You open the repository to view the list of ER configurations. If the selected project hasn't yet been used

for ER configurations sharing, the list will be empty.

11. Close the page.

12. Close the page.

1. Go to Organization administration > Electronic repor ting > ConfigurationsOrganization administration > Electronic repor ting > Configurations .

2. On the ConfigurationsConfigurations  page, in the configurations tree, select Sample model configurationSample model configuration.

You must select a created configuration that has been already completed.

3. In the list, find and select the desired record.



NOTENOTE

For this example, select the version of the selected configuration that has a status of CompletedCompleted.

4. Select Change statusChange status .

5. Select ShareShare.

The status of the configuration is changed from CompletedCompleted to SharedShared when the configuration is

published in LCS.

6. Select OKOK.

7. In the list, find and select the desired record.

For this example, select the configuration version that has a status of SharedShared.

Note that the status of the selected version was changed from CompletedCompleted to SharedShared.

8. Close the page.

9. Select Repositor iesRepositor ies .

You can now open the list of repositories for the Litware, Inc. configuration provider.

10. Select OpenOpen.

For this example, select the LCSLCS  repository, and open it.

Notice that the selected configuration is shown as an asset of the selected LCS project.

11. Open LCS by going to https://lcs.dynamics.com.

12. Open a project that was used earlier for repository registration.

13. Open the Asset library of the project.

14. Select the GER configurationGER configuration asset type.

The ER configuration that you uploaded should be listed.

Note that the uploaded LCS configuration can be imported into another instance if providers have access

to this LCS project.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Delete a shared version of a data model configuration

This topic explains how a user in the System administrator or Electronic reporting developer role can import a

new version of an Electronic reporting (ER) configuration from the project-level Asset library in Microsoft

Dynamics Lifecycle Services (LCS).

In this example, you will select the desired version of the ER configuration and import it for a sample company

that is named Litware, Inc. These steps can be completed in any company, because ER configurations are shared

among companies. To complete these steps, you must first complete the steps in Upload a configuration into

Lifecycle Services. Access to LCS is also required.

1. Sign in to the application by using one of the following roles:

Electronic reporting developer

System administrator

2. Go to Organization administrationOrganization administration > WorkspacesWorkspaces  > Electronic repor tingElectronic repor ting.

3. Select ConfigurationsConfigurations .

  

Make sure that the current Dynamics 365 Finance user is a member of the LCS project that contains the Asset library that

the user wants to access to import ER configurations.

You can't access an LCS project from an ER repository that represents a different domain than the domain that is used in

Finance. If you try, an empty list of LCS projects will be shown, and you won't be able to import ER configurations from

the project-level Asset library in LCS. To access project-level Asset libraries from an ER repository that is used to import ER

configurations, sign in to Finance by using the credentials of a user who belongs to the tenant (domain) that the current

Finance instance has been provisioned for.

1. On the ConfigurationsConfigurations  page, in the configurations tree, select Sample model configurationSample model configuration.

You created the first version of a sample data model configuration and published it to LCS when you

completed the steps in Upload a configuration into Lifecycle Services. In this procedure, you will delete

that version of the ER configuration. You will then import that version from LCS later in this topic.

2. In the list, find and select the desired record.

For this example, select the version of the configuration that has a status of SharedShared. This status indicates

that the configuration has been published to LCS.

3. Select Change statusChange status .

4. Select DiscontinueDiscontinue.

By changing the status of the selected version from SharedShared to DiscontinuedDiscontinued, you make the version

available for deletion.

5. Select OKOK.

6. In the list, find and select the desired record.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-import-configuration-lifecycle-services.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/asset-library
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For this example, select the version of the configuration that has a status of DiscontinuedDiscontinued.

7. Select DeleteDelete.

8. Select YesYes .

Notice that the only draft version 2 of the selected data model configuration is now available.

9. Close the page.

1. Go to Organization administration > Workspaces > Electronic repor tingOrganization administration > Workspaces > Electronic repor ting.

2. In the Configuration providersConfiguration providers  section, select the L itware, Inc.L itware, Inc. tile.

3. On the L itware, Inc.L itware, Inc. tile, select Repositor iesRepositor ies .

You can now open the list of repositories for the Litware, Inc. configuration provider.

4. Select OpenOpen.

For this example, select the LCSLCS  repository, and open it. You must have access to the LCS project and to

the Asset library that is accessed by the selected ER repository.

5. In the list, mark the selected row.

For this example, select the first version of Sample model configurationSample model configuration in the version list.

6. Select Impor tImpor t.

7. Select YesYes  to confirm the import of the selected version from LCS.

An informational message confirms that the selected version was successfully imported.

8. Close the page.

9. Close the page.

10. Select ConfigurationsConfigurations .

11. In the tree, select Sample model configurationSample model configuration.

12. In the list, find and select the desired record.

For this example, select the version of the configuration that has a status of SharedShared.

Notice that shared version 1 of the selected data model configuration is also available now.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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This topic explains how to download the newest version of Electronic reporting (ER) configurations from the

Shared asset library in Microsoft Dynamics Lifecycle Services (LCS).

1. Sign in to the application by using one of the following roles:

Electronic reporting developer

Electronic reporting functional consultant

System administrator

2. Go to Organization administrationOrganization administration > WorkspacesWorkspaces  > Electronic repor tingElectronic repor ting.

3. In the Configuration providersConfiguration providers  section, select the MicrosoftMicrosoft tile.

4. On the MicrosoftMicrosoft tile, select Repositor iesRepositor ies .

5. On the Configuration repositor iesConfiguration repositor ies  page, in the grid, select the existing repository of the LCSLCS  type. If

this repository doesn't appear in the grid, follow these steps:

a. Select AddAdd to add a repository.

b. Select LCSLCS  as the repository type.

c. Select Create repositor yCreate repositor y .

d. If you're prompted about authorization, follow the on-screen instructions.

e. Enter a name and description for the repository.

f. Select OKOK to confirm the new repository entry.

g. In the grid, select the new repository of the LCSLCS  type.

6. Select OpenOpen to view the list of ER configurations for the selected repository.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/download-electronic-reporting-configuration-lcs.md
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TIPTIP
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If you have trouble accessing the LCS repository to download configurations from the Shared asset library in LCS,

you can download configurations from the Global repository instead.

7. In the configurations tree in the left pane, select the required ER configuration.

8. On the VersionsVersions  FastTab, select the required version of the selected ER configuration.

9. Select Impor tImpor t to download the selected version from LCS to the current instance.

The Impor tImpor t  button is unavailable for ER configuration versions that are already present in the current instance.

Depending on the ER settings, configurations are validated after they are imported. You might be notified about any

inconsistency issues that are discovered. You must resolve those issues before you can use the imported configuration

version. For more information, see the list of related topics for this topic.

Electronic reporting (ER) overview

Download ER configurations from the Global repository of Configuration service

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/update-er-from-lcs-for-ms-make-lcs-repository.png
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This topic explains how to download Electronic reporting (ER) configurations from Microsoft Dynamics Lifecycle

Services (LCS) to a local business data application. It also explains how to upload the ER configurations from an

ER repository to the local business data (LBD) application.

NOTENOTE

NOTENOTE

1. Sign in to your local business data application by using one of the following roles:

Electronic reporting developer

Electronic reporting functional consultant

System administrator

2. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting.

3. In the Configuration providersConfiguration providers  section, select the card for the ER provider that is associated with your

company.

To learn how to register a new ER solution provider, play the Create a configuration provider and mark it asCreate a configuration provider and mark it as

activeactive task guide.

4. On the selected tile, click Repositor iesRepositor ies .

5. On the Configuration repositor iesConfiguration repositor ies  page, in the grid, select the existing repository of the File systemFile system

type. If the repository doesn't appear in the grid, follow these steps:

a. Click AddAdd to add a new repository.

b. Select FILE SYSTEMFILE SYSTEM as the repository type.

c. Click Create repositor yCreate repositor y .

d. Enter a name and description for the repository.

e. Enter the path of the working directory for this repository. This path should point to a folder of the

local file system where the ER configurations that belong to the repository will be stored.

f. Click OKOK to confirm and save the new repository.

g. In the grid, select the new repository of the File systemFile system type.

6. In your browser, open another tab, and sign in to LCS.

7. In the Shared asset library, select the GER ConfigurationGER Configuration asset type, and then click Download allDownload all .

All the ER configurations will be put into a zip file for download.

8. Open the file, select all the ER configurations, and then copy them to the working directory for the

repository of the File systemFile system type.

9. On the ER repositor iesER repositor ies  page, on the Dynamics 365 for Finance and OperationsDynamics 365 for Finance and Operations  tab, click OpenOpen to

view the list of ER configurations for the selected repository.

10. In the ConfigurationsConfigurations  tree in the left pane, select an ER configuration.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/electronic-reporting-import-ger-configurations.md
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Frequently asked questions

NOTENOTE
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11. On the VersionsVersions  FastTab, select the required version of the ER configuration.

12. Click Impor tImpor t to download the selected version from this repository to the current instance.

The Impor tImpor t  button is unavailable for existing ER configuration versions.

Depending on the ER settings, configurations are validated after they are imported. You might be notified about

inconsistencies or issues that are discovered. You must resolve these inconsistencies or issues before you can use the

imported configuration version.

Question:Question: When I click Download allDownload all  in the Shared asset library, I receive the following warning: “Zip

generation is in progress, please try again in a few minutes.” Why do I receive this warning?

Answer :Answer : You receive this warning because a new configuration is added to the Shared asset library, and the ER

configuration is being archived.

Can you tell us about your documentation language preferences? Take a short survey.
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Example: Import an ER configuration from RCS

Register a new ER repositoryRegister a new ER repository

You can use Regulatory Configuration Services (RCS) to design Electronic reporting (ER) configurations. The ER

tool provides access to the list of configurations that have been configured in each instance of RCS that has

been provisioned for your company. You can use this feature to import configurations that you configured in an

RCS instance into the current instance. After configurations are imported, they can be used to handle incoming

documents or generate outgoing electronic documents.

To learn more about this feature, complete the example in this topic. Alternatively, play the ER Impor tER Impor t

configurations from RCSconfigurations from RCS  task guide, which is part of the 7.5.4.3 Acquire/Develop IT service/solution

components (10677) business process. This task guide can be downloaded from the Microsoft Download

Center. It walks you through the process of importing ER configurations from an RCS instance into the current

instance.

This example shows how a user in the System Administrator or Electronic Reporting Developer role can import

a new version of an ER configuration from RCS. In this example, you select the desired version of the ER

configuration that has been configured in an RCS instance, and you import that version into the current instance

for a sample company that is named Litware, Inc. These steps can be completed in any company, because ER

configurations are shared among companies.

To complete the steps in this example, you must first complete the steps in Create configuration providers and

mark them as active. You must also have access to an RCS instance that contains at least one ER configuration

that has a status of either CompletedCompleted or SharedShared.

1. Go to Organization administration > Workspaces > Electronic repor tingOrganization administration > Workspaces > Electronic repor ting.

2. On the Localization configurationsLocalization configurations  page, in the Configuration providersConfiguration providers  section, make sure that the

configuration provider for the Litware, Inc. sample company is listed, and that it's marked as ActiveActive. If you

don't see this configuration provider, follow the steps in Create configuration providers and mark them as

active.

3. If no RCS environment has been provisioned for your company, in the External L inksExternal L inks  section, select

Regulator y ser vices – ConfigurationRegulator y ser vices – Configuration. Then follow the instructions to provision an RCS environment.

4. In the Related linksRelated links  section, select Electronic repor ting parametersElectronic repor ting parameters .

5. On the Electronic repor ting parametersElectronic repor ting parameters  page, select the RCSRCS  tab.

6. Use the URLs on this tab to access the RCS environment has been provisioned for your company.

7. Close the Electronic repor ting parametersElectronic repor ting parameters  page.

1. On the Localization configurationsLocalization configurations  page, select the L itware, Inc.L itware, Inc. configuration provider in the list.

2. Select Repositor iesRepositor ies .

3. Select AddAdd to open the drop-down dialog box.

4. Select RCSRCS  as the configuration repository type, and then select Create repositor yCreate repositor y .

5. In the RCS environment display nameRCS environment display name field, select the desired RCS instance. Note that you can have

several instances.

6. Select OKOK.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/rcs-download-configurations.md
https://go.microsoft.com/fwlink/?linkid=2082739


Import ER configurations from an RCS-based repositoryImport ER configurations from an RCS-based repository

Additional resource

NOTENOTE

1. On the Configuration repositor iesConfiguration repositor ies  page, select the Show filtersShow filters  button on the left side of the window.

2. For the NameName filter, select begins withbegins with as the filter operator, and then enter RCSRCS  as the filter value.

3. Select the repository, and open it.

4. On the Connect to Regulator y Configuration Ser vicesConnect to Regulator y Configuration Ser vices  page, select the Click here to connect toClick here to connect to

Regulator y Configuration Ser vicesRegulator y Configuration Ser vices  link.

5. Select OpenOpen.

6. Select CloseClose.

7. Select the desired version of the ER configuration, and then select Impor tImpor t to import that version.

Electronic reporting (ER) overview

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Register a new ER repository.

Import ER configurations from RCS-based repository

The following steps explain how a user in the System Administrator or Electronic Reporting Developer role can

import a new version of an Electronic reporting (ER) configuration from Microsoft Regulatory Configuration

Services (RCS). In this example, you will select the version of the ER configuration that has been configured in an

RCS instance and import it into the current instance for sample company, Litware, Inc. These steps can be

performed in any company because ER configurations are shared among companies. To complete these steps,

you must first complete the steps in the topic, Create configuration providers and mark them as active. To

complete these steps, you must also have access to an RCS instance containing at least one ER configuration in

either CompletedCompleted or SharedShared status.

1. Go to Organization administrationOrganization administration > WorkspacesWorkspaces  > Electronic repor tingElectronic repor ting.

2. Make sure that the configuration provider for the sample company, Litware, Inc., is available and marked as

ActiveActive. If you don't see this configuration provider, complete the steps in the topic, Create configuration

providers and mark them as active.

3. If you have no RCS environment provisioned to your company, select Regulator y ser vices –Regulator y ser vices –

ConfigurationConfiguration external link and follow the instructions to provision an RCS environment.

4. Select Electronic repor ting parametersElectronic repor ting parameters .

5. Select the RCSRCS  tab.

6. If RCS environment has been already provisioned to your company, use presented on the page URLs to

access it.

7. Close the page.

1. In the list, mark the selected row.

2. Select Litware, Inc. provider.

3. Select Repositories.

4. Select Add to open the drop dialog.

5. In the Configuration repository type field, enter 'RCS'.

6. Select Create repository.

7. In the RCS environment display name field, enter or select a value.

8. Select the desired RCS instance. You can have several of them.

9. Select OK.

1. Select Show filtersShow filters .

2. Enter a filter value of "RCS" on the NameName field using the begins withbegins with filter operator.

3. When you open the selected repository, on the Connect to Regulator y Configuration Ser vicesConnect to Regulator y Configuration Ser vices  page,

select Select here to connect to Regulator y Configuration Ser vicesSelect here to connect to Regulator y Configuration Ser vices  link.

4. Select OpenOpen.

5. Select CloseClose.

6. Select the desired version of ER configuration and select Impor tImpor t to bring it in the current instance.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/import-configuration-rcs.md
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Example: Use JOIN data sources in ER model mappings

PrerequisitesPrerequisites

While configuring Electronic reporting (ER) model mappings or formats, you can add required data sources of

the JoinJoin type. At design time, a JoinJoin data source is configured as a set of several data sources each of which

returns a list of records. For every data source except the first one, you need to define necessary conditions to

join records of the current and previous data sources. At runtime, a configured data source of JoinJoin type returns

a single joined list of records containing fields from the records of nested data sources.

The following types of joins are currently supported:

Outer (left) join:

Inner (right) join:

Join all records of the first (left-most) data source and then any matching in accordance to configured

conditions records of the second (right-most) data source.

Join only records of the first (left-most) data source and only records of the second (right-most) data

source matching to each other in accordance to configured conditions.

In the configured JoinJoin data source, when all data sources are the Table recordsTable records  type, execution of the Join data

source can be performed at the database level using a single SQL statement. This statement reduces the number

of database calls, which improves model-mapping performance. Otherwise, execution of Join dataJoin data source is

performed in memory.

Using the VALUEINVALUEIN function in ER expressions that specify conditions for joining records in data sources of Join type is

not supported yet. Visit the Formula designer in Electronic reporting page for more details about this function.

To learn more about this feature, complete the example in this topic.

The following steps explain how the System administrator or Electronic reporting developer can configure an

Electronic reporting (ER) model mapping to get data from multiple application tables at once by using data

sources of the JoinJoin type to improve data access performance. These steps can be performed for any company of

Dynamics 365 Finance or Regulatory Configuration Services (RCS).

To complete the examples in this topic, you must have access to one of the following depending on what service

is used to compete these steps:

Access to Finance for one of the following roles:Access to Finance for one of the following roles:

Electronic reporting developer

Electronic reporting functional consultant

System administrator

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-join-data-sources.md
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Sample ER data modelER data model configuration file, which is used as
the data source for the examples.

Model to learn JOIN data sources.version.1.1.xml

Sample ER model mappingER model mapping configuration file, which
implements the ER data model for the examples.

Mapping to learn JOIN data sources.version.1.1.xml

Sample ER formatER format  configuration file. This file describes the
data to populate the ER format component for the examples.

Format to learn JOIN data sources.version.1.1.xml

Activate a configurations providerActivate a configurations provider

Import sample ER configuration filesImport sample ER configuration files

Access to RCS for one of the following roles:Access to RCS for one of the following roles:

Electronic reporting developer

Electronic reporting functional consultant

System administrator

You also must first complete the steps in the Create a configuration provider and mark it as active procedure.

In advance, you must also download from Microsoft Download Center and save locally the following sample ER

configuration files:

1. Access either Finance or RCS in the first session of your web browser.

2. Go to Organization administration > Workspaces > Electronic repor tingOrganization administration > Workspaces > Electronic repor ting.

3. On the Localization configurationsLocalization configurations  page, in the Configuration providersConfiguration providers  section, make sure that

the configuration provider for the Litware, Inc. sample company is listed, and that it's marked as ActiveActive. If

you don't see this configuration provider, follow the steps in Create a configuration provider and mark it

as active procedure.

1. Select Repor ting configurationsRepor ting configurations .

2. Import the ER data model configuration file.

a. Select ExchangeExchange.

b. Select Load from XML fileLoad from XML file.

https://go.microsoft.com/fwlink/?linkid=000000
https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg
https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg
https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg
http://www.litware.com


Turn on execution trace optionsTurn on execution trace options

c. Select BrowseBrowse to find the Model to learn JOIN data sources.version.1.1 .xmlModel to learn JOIN data sources.version.1.1 .xml  file.

d. Select OKOK.

3. Import the ER model-mapping configuration file.

a. Select ExchangeExchange.

b. Select Load from XML fileLoad from XML file.

c. Select BrowseBrowse to find the Mapping to learn JOIN data sources.version.1.1 .xmlMapping to learn JOIN data sources.version.1.1 .xml  file.

d. Select OKOK.

4. Import the ER format configuration file.

a. Select ExchangeExchange.

b. Select Load from XML fileLoad from XML file.

c. Select BrowseBrowse to find the Format to learn JOIN data sources.version.1.1 .xmlFormat to learn JOIN data sources.version.1.1 .xml  file.

d. Select OKOK.

5. In the configurations tree, expand the Model to learn JOIN data sourcesModel to learn JOIN data sources  item as well as other model

items (when available).

6. Observe the list of ER configurations in the tree as well as version details on the VersionsVersions  fast tab – they

will be used as the source of data for your sample report.

1. Select CONFIGURATIONSCONFIGURATIONS .

2. Select User parametersUser parameters .

3. Set execution trace parameters as shown on the screenshot below.



Review ER model mapping (part 1)Review ER model mapping (part 1)

With these parameters turned on, for every execution of the imported ER format file, the execution trace

will be generated. Using details of generated execution trace, you can analyze the execution of ER format

and ER model-mapping components. Visit the Trace execution of ER format to troubleshoot performance

issues page for more details about ER execution trace feature.

Review settings of the ER model-mapping component. The component is configured to access information

about versions of ER configurations, details of configurations and configuration providers without using data

sources of the JoinJoin type.

1. Select Mapping to learn JOIN data sourcesMapping to learn JOIN data sources  configuration.

2. Select DesignerDesigner  to open the list of mappings.

3. Select DesignerDesigner  to review the mapping details.

4. Select Show detailsShow details .

5. In the configurations tree, expand the Set1Set1  and Set1.DetailsSet1.Details  data model items:

a. Binding Details : Record list = VersionsDetails : Record list = Versions  indicates that the Set1.DetailsSet1.Details  item is bound to the

VersionsVersions  data source returning records of the ERSolutionVersionTableERSolutionVersionTable table. Each record of this

table represents a single version of an ER configuration. The content of this table is presented in the

VersionsVersions  fast tab on the ConfigurationsConfigurations  page.

b. Binding ConfigurationVersion: Str ing = @.PublicVersionNumberConfigurationVersion: Str ing = @.PublicVersionNumber  means that the value of the

public version of each ER configuration’s version is taken from the PublicVersionNumberPublicVersionNumber  field of

the ERSolutionVersionTableERSolutionVersionTable table and placed to the ConfigurationVersionConfigurationVersion item.

c. Binding ConfigurationTitle: Str ing = @.'>Relations' .Solution.NameConfigurationTitle: Str ing = @.'>Relations' .Solution.Name indicates that the name of

an ER configuration is taken from the NameName field of the ERSolutionTableERSolutionTable table assessing by using

the many-to-one relation ('>Relations''>Relations' ) between the ERSolutionVersionTableERSolutionVersionTable and

ERSolutionTableERSolutionTable tables. Names of ER configurations of the current application instance are

presented in the configurations tree on the ConfigurationsConfigurations  page.

d. Binding @.'>Relations' .Solution.'>Relations' .SolutionVendor.Name@.'>Relations' .Solution.'>Relations' .SolutionVendor.Name means that the name of

the configuration provider that owns the current configuration is taken from the NameName field of the

ERVendorTableERVendorTable table assessing by using the many-to-one relation between ERSolutionTableERSolutionTable and

ERVendorTableERVendorTable tables. Names of ER configuration providers are presented in the configurations tree

on the ConfigurationsConfigurations  page on the page header for each configuration. The entire list of ER

configuration providers can be found on the Organization administration > ElectronicOrganization administration > Electronic

repor ting > Configuration providerrepor ting > Configuration provider  table page.



  Review ER model mapping (part 2)Review ER model mapping (part 2)

6. In the configurations tree, expand the Set1.Summar ySet1.Summar y  data model item:

a. Binding VersionsNumber : Integer = VersionsSummar y.aggregated.VersionsNumberVersionsNumber : Integer = VersionsSummar y.aggregated.VersionsNumber

indicates that the Set1.Summar y.VersionsNumberSet1.Summar y.VersionsNumber  item is bound to the VersionsNumberVersionsNumber

aggregation field of the VersionsSummar yVersionsSummar y  data source of the GroupByGroupBy  type that was configured to

return the number of records of the ERSolutionVersionTableERSolutionVersionTable table via the VersionsVersions  data source.

7. Close the page.

Review settings of the ER model-mapping component. The component is configured to access information

about versions of ER configurations, details of configurations and configuration providers with using a data

source of the JoinJoin type.

1. In the configurations tree, expand the Set2Set2  and Set2.DetailsSet2.Details  data model items. The binding Details :Details :

Record list = DetailsRecord list = Details  indicates that the Set2.DetailsSet2.Details  item is bound to the DetailsDetails  data source

configured as the data source of the JoinJoin type.

The JoinJoin data source can be added by selecting the Functions\JoinFunctions\Join data source:



2. Select DetailDetail s data source.

3. Select EditEdit in the Data sourcesData sources  pane.

4. Select Edit joinEdit join .

5. Select Show detailsShow details .

This page is used to design the required data source of the Join typeJoin type. At runtime, this data source will

create a single joined list of records from the data sources in the Joined listJoined list grid. Join of records will

start from the ConfigurationProvidersConfigurationProviders  data source that is in the grid as a first one (the TypeType column is

blank for it). Records of every other data source will be joined consequently to records of the parent data

source based on its order in this grid. Every joining data source must be configured as a data source

nested under a target data source ( 1Versions  data source is nested under 1Configurations  one; 

1Configurations  data source is nested under ConfigurationProvidersConfigurationProviders  one). Each configured data

source must contain the conditions for the join. In the data source for this particular JoinJoin , the following

joins are defined:

Each record of the ConfigurationProvidersConfigurationProviders  data source (referred to the ERVendorTableERVendorTable table) is

joined with only records of the 1Configurations1Configurations  one (referred to in the ERSolutionTableERSolutionTable table)

having the same value in the SolutionVendorSolutionVendor  and RecIdRecId fields. The Inner joinInner join type is used for this

join as well as the following conditions for matching records:

FILTER (Configurations, Configurations.SolutionVendor = ConfigurationProviders.RecId)

Each record of the 1Configurations1Configurations  data source (referred to the ERSolutionTableERSolutionTable table) is joined

with the only records of the 1Versions1Versions  one (referred to the ERSolutionVersionTableERSolutionVersionTable table) having

the same value in the SolutionSolution and RecIdRecId fields. Inner joinInner join type is used for this join as well as the

following conditions for matching records:

FILTER (ConfigurationVersions, ConfigurationVersions.Solution =



Execute ER formatExecute ER format

ConfigurationProviders.'1Configurations'.RecId)

ExecuteExecute option is configured as Quer yQuer y  meaning that this join data source will be executed at runtime

on database level as a direct SQL call.

For joining records of data sources representing application tables, you can specify join conditions by

using pairs of fields other than ones that describe existing in AOT relations between these tables. This

type of join can be configured to execute at the database level as well.

6. Close the page.

7. Select CancelCancel .

8. In the configurations tree, expand the Set2.Summar ySet2.Summar y  data model item:

Binding VersionsNumber : Integer = DetailsSummar y.aggregated.VersionsNumberVersionsNumber : Integer = DetailsSummar y.aggregated.VersionsNumber  indicates

that the Set2.Summar y.VersionsNumberSet2.Summar y.VersionsNumber  item is bound to the VersionsNumberVersionsNumber  aggregation field

of the DetailsSummar yDetailsSummar y  data source of the GroupByGroupBy  type that was configured to return the number

of joined records of the DetailsDetails  data source of the JoinJoin type.

The ExecutionExecution location option is configured as Quer yQuer y  meaning that this GroupByGroupBy  data source will

be run at runtime as a direct SQL call at the database level. This behavior is possible because the base

data source DetailsDetails  of the JoinJoin type is configured as executed at the database level.

9. Close the page.

10. Select CancelCancel .

1. Access Finance or RCS in the second session of your web browser using same credentials and company

as in the first session.

2. Go to Organization administration > Electronic repor ting > ConfigurationsOrganization administration > Electronic repor ting > Configurations .

3. Expand Model to learn JOIN data sourcesModel to learn JOIN data sources  configuration.

4. Select Format to learn JOIN data sourcesFormat to learn JOIN data sources  configuration.

5. Select DesignerDesigner .

6. Select Show detailsShow details .

7. Select MappingMapping.

8. Select Expand/CollapseExpand/Collapse.

This format is designed to populate a generated text file with a new line for every version of an ER

configuration (VersionVersion sequence). Each generated line will contain the name of a configuration provider

owning the current configuration, the configuration name, and the configuration version separated by

semicolon mark. The final line of generated file will contain the number of discovered versions of ER



configurations (Summar ySummar y  sequence).

The DataData and Summar ySummar y  data sources are used to populate configuration version details to the

generated file:

Information from the Set1Set1  data model is used when you choose NoNo for the SelectorSelector  data source at

runtime on the user dialog page when running ER format.

Information from the Set2Set2  data model is used when you choose YesYes  for the SelectorSelector  data source at

runtime on the user dialog page.

9. Select RunRun.

10. On the dialog page, select NoNo in the Use JOIN data sourceUse JOIN data source field.

11. Select OKOK.

12. Review generated file.



Analyze ER format execution traceAnalyze ER format execution trace

Execute ER formatExecute ER format

1. In the first session of Finance or RCS, select DesignerDesigner .

2. Select Performance tracPerformance trace.

3. In the Performance tracePerformance trace grid, select the top-most record of the latest execution trace of an ER format

that used the current model mapping component.

4. Select OKOK.

Execution statistics informs you about duplicated calls to application tables:

ERSolutionTableERSolutionTable has been called as many times as you have configuration version records in the

ERSolutionVersionTableERSolutionVersionTable table, while the number of such calls could be reduced in times for

performance improvement.

ERVendorTableERVendorTable has been called twice for every configuration version record that was discovered in

the ERSolutionVersionTableERSolutionVersionTable table, while the number of such calls could be reduced as well.

5. Close the page.

1. Switch to your web browser tab with the second session of Finance or RCS.
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2. Select RunRun.

3. On the dialog page, select YesYes  in the Use JOIN data sourceUse JOIN data source field.

4. Select OKOK.

5. Review generated file.

1. In the first session of Finance or RCS, select DesignerDesigner .

2. Select Performance tracePerformance trace.

3. In the Performance tracePerformance trace grid, select top-most record representing the latest execution trace of an ER

format that used the current model mapping component.

4. Select OKOK.

Statistics informs you about the following:

Application database has been called once to get records from ERVendorTableERVendorTable, ERSolutionTableERSolutionTable,

and ERSolutionVersionTableERSolutionVersionTable tables to access required fields.

Application database has been called once to calculate the number of configuration versions by using

joins that were configured in the DetailsDetails  data source.



Limitations

ExampleExample

As you can see from the example in this topic, the JOINJOIN data source can be built from several data sources that

describe the individual datasets of the records that must eventually be joined. You can configure those data

sources by using the built-in ER FILTER function. When you configure the data source so that it's called beyond

the JOINJOIN data source, you can use company ranges as part of the condition for data selection. The initial

implementation of the JOINJOIN data source doesn't support data sources of this type. For example, when you call a

FILTER-based data source within the scope of execution of a JOINJOIN data source, if the called data source contains

company ranges as part of the condition for data selection, an exception occurs.

In Microsoft Dynamics 365 Finance version 10.0.12 (August 2020), you can use company ranges as part of the

condition for data selection in FILTER-based data sources that are called within the scope of execution of a JOINJOIN

data source. Because of the limitations of the application query builder, the company ranges are supported only

for the first data source of a JOINJOIN data source.

For example, you must make a single call to the application database to get the list of foreign trade transactions

of multiple companies and the details of the inventory item that is referred to in those transactions.

In this case, you configure the following artifacts in your ER model mapping:

IntrastatIntrastat root data source that represents the IntrastatIntrastat table.

ItemsItems root data source that represents the InventTableInventTable table.

CompaniesCompanies  root data source that returns the list of companies (DEMFDEMF and GBSIGBSI in this example) where

transactions must be accessed. The company code is available from the Companies.CodeCompanies.Code field.

X1X1  root data source that has the expression 

FILTER (Intrastat, VALUEIN(Intrastat.dataAreaId, Companies, Companies.Code)) . As part of the condition for

data selection, this expression contains the definition of company ranges 

VALUEIN(Intrastat.dataAreaId, Companies, Companies.Code) .

X2X2  data source as a nested item of the X1X1  data source. It includes the expression 

FILTER (Items, Items.ItemId = X1.ItemId) .

Finally, you can configure a JOINJOIN data source where X1X1  is the first data source and X2X2  is the second data source.

You can specify Quer yQuer y  as the ExecuteExecute option to force ER to run this data source on the database level as a

direct SQL call.

When the configured data source is run while the ER execution is traced, the following statement is shown in the

ER model mapping designer as part of the ER performance trace.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-ref/xpp-library-objects
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SELECT ... FROM INTRASTAT T1 CROSS JOIN INVENTTABLE T2 WHERE ((T1.PARTITION=?) AND (T1.DATAAREAID IN
(N'DEMF',N'GBSI') )) AND ((T2.PARTITION=?) AND (T2.ITEMID=T1.ITEMID AND (T2.DATAAREAID = T1.DATAAREAID) AND
(T2.PARTITION = T1.PARTITION))) ORDER BY T1.DISPATCHID,T1.SEQNUM

An error occurs if you run a JOINJOIN data source that has been configured so that it contains data selection conditions that

have company ranges for additional data sources of the executed JOINJOIN data source.

Formula designer in Electronic reporting

Trace execution of ER format to troubleshoot performance issues

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Prerequisites

Single model mapping case

Run the configured formatRun the configured format

You can configure Electronic reporting (ER) model mappings so that they implement a generic ER data model

but are specific to Dynamics 365 Finance. This topic explains how to design multiple ER model mappings for an

ER data model to control how they are used by corresponding ER formats that are run from companies that

have different country/region contexts.

To complete the examples in this topic, you must have the following access:

Access to Finance for one of the following roles:

Electronic reporting developer

Electronic reporting functional consultant

System administrator

Access to the instance of Regulatory Configuration Services (RCS) that has been provisioned for the same

tenant as Finance for one of the following roles:

Electronic reporting developer

Electronic reporting functional consultant

System administrator

Some steps in this topic require execution of an ER format. In some cases, execution of an ER format is affected

by the country/region context of the company that you're currently signed in to. You can run an ER format in the

current RCS instance if the company that has the required country/region context is available in RCS. Otherwise,

you must upload a completed version of the ER model mapping and ER format configurations that use the ER

data model to your Finance instance, and then run the ER format in that Finance instance. For information about

how to import configurations that reside in RCS into a Finance instance, see Import configurations from RCS.

Follow the steps in Appendix 1 of this topic to design the required ER components. You now have the MappingMapping

(General)(General)  model mapping configuration that contains the model mapping for the Entr y point 1Entr y point 1  definition.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-country-dependent-model-mapping.md


Multiple shared model mappings case

Run the configured formatRun the configured format

Define a default mapping configurationDefine a default mapping configuration

1. On the Configurations pageConfigurations page, on the VersionsVersions  FastTab, select RunRun.

2. Select OKOK.

Notice that the web browser offers to download the text file that was generated by executed ER format. Because

this format was configured to use the Entr y point 1Entr y point 1  definition, and only a single model mapping is currently

available for the base model that contains a mapping for this definition, the executed ER format used the

Mapping (General)Mapping (General)  model mapping of the Mapping (General)Mapping (General)  configuration as a data source. Therefore, the

downloaded file contains the Generic functionality 1Generic functionality 1  text.

Follow the steps in Appendix 2 of this topic to design the required ER components. You now have MappingMapping

(General)(General)  and Mapping (General) customMapping (General) custom model mapping configurations, each of which contains the model

mapping for the Entr y point 1Entr y point 1  definition.

1. On the ConfigurationsConfigurations  page, in the configurations tree, select Format to learn mappingsFormat to learn mappings .

2. On the VersionsVersions  FastTab, select RunRun.

3. Select OKOK.

Notice that execution of the selected ER format is unsuccessful. An error message informs you that more than

one model mapping exists for the Model to learn mappingsModel to learn mappings  model and the Entr y point 1Entr y point 1  definition in the

Mapping (General)Mapping (General)  and Mapping (General) customMapping (General) custom model mapping configurations. The message also

recommends that you select one of those configurations as the default configuration.

Follow these steps to define the Mapping (General) customMapping (General) custom model mapping configuration as the default

configuration, so that its mappings can be used as data sources for the Format to learn mappingsFormat to learn mappings  ER format.

1. On the ConfigurationsConfigurations  page, in the configurations tree, select Mapping (General) customMapping (General) custom.



Run the configured formatRun the configured format
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Multiple mixed model mappings case

2. As required, select EditEdit to make the current page ready for editing.

3. Set the Default for model mappingDefault for model mapping option to YesYes .

4. Select SaveSave.

1. On the ConfigurationsConfigurations  page, in the configurations tree, select Format to learn mappingsFormat to learn mappings .

2. On the VersionsVersions  FastTab, select RunRun.

3. Select OKOK.

Notice that execution of the selected ER format succeeds. The web browser offers to download the text file that

was generated by executed ER format. Because this format was configured to use the Entr y point 1Entr y point 1  definition,

and the Mapping (General) customMapping (General) custom model mapping configuration was selected as the default configuration,

the executed ER format used the Mapping (General) copyMapping (General) copy  model mapping of the Mapping (General)Mapping (General)

customcustom configuration as a data source. Therefore, the downloaded file contains the Generic functionality 1Generic functionality 1

customcustom text.

If you change the company that you're currently signed in to and run this ER format again, you get the same content in

the generated file, because the default ER model mapping configuration doesn't contain any company-dependent

restrictions.

Follow the steps in Appendix 3 of this topic to design the required ER components. You now have MappingMapping

(General)(General) , Mapping (General) customMapping (General) custom, and Mapping (FR) model mappingMapping (FR) model mapping configurations that contain

the model mapping for the Entr y point 1Entr y point 1  definition.

Notice that version 1 of the Mapping (FR)Mapping (FR)  model mapping configuration is configured so that it applies only to

ER formats of the Model to learn mappingsModel to learn mappings  model that are run in Finance companies that have French

country/region context.



Run the configured formatRun the configured format

Define the France-specific mapping configuration as the default configurationDefine the France-specific mapping configuration as the default configuration

Run the configured formatRun the configured format

1. Change the company to FRSIFRSI.

2. On the ConfigurationsConfigurations  page, in the configurations tree, select Format to learn mappingsFormat to learn mappings .

3. On the VersionsVersions  FastTab, select RunRun.

4. Select OKOK.

Notice that execution of the selected ER format succeeds. The web browser offers to download the text file that

was generated by the executed ER format. Because this format was configured to use the Entr y point 1Entr y point 1

definition, and the Mapping (General) customMapping (General) custom model mapping configuration was selected as the default

configuration, the executed ER format used the Mapping (General) copyMapping (General) copy  model mapping of the MappingMapping

(General) custom(General) custom configuration as a data source. Therefore, the downloaded file contains the GenericGeneric

functionality 1 customfunctionality 1 custom text.

Follow these steps to define the custom Mapping (FR)Mapping (FR)  model mapping configuration as the default

configuration. Note that, because this mapping is specific to France, it will be considered the default mapping

between all model mapping configurations that have the FRFR  country code specified in the ISO countr y/regionISO countr y/region

codescodes  field.

1. On the ConfigurationsConfigurations  page, in the configurations tree, select Mapping (FR)Mapping (FR) .

2. As required, select EditEdit to make the current page ready for editing.

3. Set the Default for model mappingDefault for model mapping option to YesYes .

4. Select SaveSave.

1. On the ConfigurationsConfigurations  page, in the configurations tree, select Format to learn mappingsFormat to learn mappings .

2. On the VersionsVersions  FastTab, select RunRun.



NOTENOTE

Other model mapping cases

3. Select OKOK.

Notice that execution of the selected ER format succeeds. The web browser offers to download the text file that

was generated by the executed ER format. Because this format was configured to use the Entr y point 1Entr y point 1

definition, and the Mapping (FR)Mapping (FR)  model mapping configuration was selected as the default configuration, the

executed ER format used the Mapping (FR)Mapping (FR)  model mapping of the Mapping (FR)Mapping (FR)  configuration as a data

source. Therefore, the downloaded file contains the FR functionality 1FR functionality 1  text.

If you change the company that you're currently signed in to and run this ER format again, the output will depend on the

country/region context of the selected company.

As you've seen, the selection of a model mapping for the execution of an ER format works in the following way:

The model mapping definition that an ER format uses is specified (Entr y point 1Entr y point 1  in the examples in this

topic).

All mapping configurations that contain a mapping that has the specified definition, and that satisfy any

country/region context restrictions that are configured, can potentially be used to run the ER format

(Mapping (General)Mapping (General) , Mapping (General) customMapping (General) custom, and Mapping (FR)Mapping (FR)  in the examples in this topic).

Any default model mapping that has country/region context restrictions has the highest priority for selection

(Mapping (FR)Mapping (FR)  in the examples in this topic).

Any default model mapping that doesn't have country/region context restrictions has the next higher priority

for selection (Mapping (General) customMapping (General) custom in the examples in this topic).

Any model mapping that has country/region context restrictions has higher priority for selection than a

model mapping that doesn't have country/region context restrictions.

The following table provides information about the results of model mapping selection for all possible cases for

model mapping settings:

Column 1 indicates whether the first model mapping that doesn't have country/region context restrictions

(for example, the shared Mapping (General)Mapping (General)  mapping) is presented and, if it is, whether the Default forDefault for

model mappingmodel mapping option is set to YesYes  for it.

Column 2 indicates whether the second model mapping that doesn't have country/region context restrictions

(for example, the shared Mapping (General) customMapping (General) custom mapping) is presented and, if it is, whether the

Default for model mappingDefault for model mapping option is set to YesYes  for it.

Column 3 indicates whether the first model mapping that has country/region A context restrictions (for

example, the France-specific Mapping (FR)Mapping (FR)  mapping) is presented and, if it is, whether the Default forDefault for

model mappingmodel mapping option is set to YesYes  for it.

Column 4 indicates whether the second model mapping that has country/region A context restrictions is

presented and, if it is, whether the Default for model mappingDefault for model mapping option is set to YesYes  for it.

Column 5 presents the result of a model mapping selection for execution of an ER format under the control

of a company that has country/region A context.

Column 6 presents the result of a model mapping selection for execution of an ER format under the control

of a company that has country/region B context.

In the table, a plus sign (+) indicates the presence of a model mapping configuration in the current instance of

the Microsoft Azure service that is used to run an ER format (either Finance or RCS).
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1 2 3 4 5 6

1 Error (missing
mapping)

Error (missing
mapping)

2 + MM1 MM1

3 + + Error (multiple
mappings)

Error (multiple
mappings)

4 + + MM1A MM1

5 + + + Error (multiple
mappings)

MM1

6 + default + + MM2 MM2

7 + default MM1A MM1

8 + default + MM1A MM1

9 + default default Error (multiple
mappings)

MM1

10 default MM1 MM1

11 default + MM1 MM1

12 default + MM1 MM1

13 default default Error (multiple
mappings)

Error (multiple
mappings)

14 default default MM1A MM1

15 default default default MM1A MM2A

16 + + MM1A MM2A

17 default default MM1A MM2A

Learn what mapping was used in the execution of an ER format
Configure ER user parametersConfigure ER user parameters
1. On the ConfigurationsConfigurations  page, on the Action Pane, on the CONFIGURATIONSCONFIGURATIONS  tab, select User parametersUser parameters .

2. Set the Run in debug modeRun in debug mode option to YesYes .



 

Run the configured formatRun the configured format

Review the ER debug logReview the ER debug log

Appendix 1
Configure a sample data modelConfigure a sample data model

Create an ER data model configurationCreate an ER data model configuration

Design a sample data modelDesign a sample data model

3. Select OkOk.

1. On the ConfigurationsConfigurations  page, in the configurations tree, select Format to learn mappingsFormat to learn mappings .

2. On the VersionsVersions  FastTab, select RunRun.

3. Select OkOk.

1. In the navigation pane, go to Modules > Organization administration > Electronic repor ting >Modules > Organization administration > Electronic repor ting >

Configuration debug logConfiguration debug log.

2. Select the Reload this pageReload this page button.

Notice that a new record has been added to the ER debug log for the executed ER format. Because the LevelLevel

field of this record is set to InfoInfo, the record is informational. Because the Format component field is set to

Mapping configurationMapping configuration, the record informs you about a model mapping that was used during execution of

the Format to learn mappingsFormat to learn mappings  ER format (selected in the Configuration nameConfiguration name field). The content of the

Generated textGenerated text field informs you that the Mapping (FR)Mapping (FR)  mapping component that resides in the MappingMapping

(FR)(FR)  configuration has been used to run this report.

Sign in to your RCS instance.

In this example, you will create a configuration for sample company, Litware, Inc. To complete these steps, you

must first complete, in RCS, the steps in the Create a configuration provider and mark it as active procedure.

1. On the default dashboard, select Electronic repor tingElectronic repor ting.

2. Select the Repor ting configurationsRepor ting configurations  tile.

3. On the ConfigurationsConfigurations  page, select Create configurationCreate configuration.

4. In the drop-down dialog box, in the NameName field, enter Model to learn mappingsModel to learn mappings .

5. Select Create configurationCreate configuration.

6. Select the Configuration componentsConfiguration components  FastTab.

Notice that draft version 1 of this ER configuration is ready for editing. This version contains the data model

component.



Complete the modified version of the model configurationComplete the modified version of the model configuration

1. On the Configurations pageConfigurations page, select DesignerDesigner .

2. Select NewNew .

3. In the drop-down dialog box, in the NameName field, enter Entr y point 1Entr y point 1 .

4. Select AddAdd.

5. Select NewNew .

6. In the drop-down dialog box, in the NameName field, enter Functionality descr iptionFunctionality descr iption.

7. Select AddAdd.

8. Select NewNew .

9. In the drop-down dialog box, in the New nodeNew node field group, select Model rootModel root.

10. In the NameName field, enter Entr y point 2Entr y point 2 .

11. Select Entr y point 2Entr y point 2 .

12. Select AddAdd.

13. Select NewNew .

14. In the drop-down dialog box, in the NameName field, enter Functionality descr iptionFunctionality descr iption.

15. Select AddAdd.

16. Select SaveSave.

17. Close the page.

1. On the ConfigurationsConfigurations  page, on the VersionsVersions  FastTab, select Change statusChange status .

Change the status of designed model configuration from DraftDraft to CompletedCompleted, so that it can be used

to design the required model mappings and formats.

2. Select CompleteComplete.

3. Select OKOK.



Configure a sample model mappingConfigure a sample model mapping
Create an ER model mapping configurationCreate an ER model mapping configuration

Design a sample model mappingDesign a sample model mapping

Notice that the configuration that you created is saved as completed version 1.

1. On the ConfigurationsConfigurations  page, select Create configurationCreate configuration.

2. In the drop-down dialog box, in the NewNew  field group, select Model mapping based on data modelModel mapping based on data model

Model to learn mappingsModel to learn mappings .

3. In the NameName field, enter Mapping (General)Mapping (General) .

4. In the Data model definitionData model definition field, select Entr y point 1Entr y point 1 .

5. Select Create configurationCreate configuration.

Notice that draft version 1 of this ER configuration is ready for editing. This version contains the model mapping

component.

1. On the ConfigurationsConfigurations  page, select DesignerDesigner .

Notice that the model mapping of the To modelTo model  direction type has been automatically added to this

component for the Entr y point 1Entr y point 1  definition.

2. Select DesignerDesigner  to start editing the added model mapping.

3. In the Data modelData model  section, select EditEdit.

4. In the FormulaFormula field, enter "Generic functionality 1""Generic functionality 1".

5. Select SaveSave.

6. Close the Formula designerFormula designer  page.

7. Select SaveSave.

8. Close the Model mapping designerModel mapping designer  page.

9. Select NewNew .

10. In the DefinitionDefinition field, select Entr y point 2Entr y point 2 .

11. In the NameName field, enter Mapping (General) 2Mapping (General) 2 .

12. Select DesignerDesigner .

13. In the Data modelData model  section, select EditEdit.

14. In the FormulaFormula field, enter "Generic functionality 2""Generic functionality 2".

15. Select SaveSave.

16. Close the Formula designerFormula designer  page.



Complete the modified version of the model mapping configurationComplete the modified version of the model mapping configuration

Configure a sample formatConfigure a sample format
Create an ER format configurationCreate an ER format configuration

Design a sample formatDesign a sample format

17. Select SaveSave.

18. Close the Model mapping designerModel mapping designer  page.

19. Close the Model mappingsModel mappings  page.

1. On the Configurations pageConfigurations page, on the VersionsVersions  FastTab, select Change statusChange status .

Change the status of designed model mapping configuration from DraftDraft to CompletedCompleted, so that it

can be used by ER formats.

2. Select CompleteComplete.

3. Select OKOK.

Notice that the configuration that is created is saved as completed version 1.

1. On the ConfigurationsConfigurations  page, in the configurations tree, select Model to learn mappingsModel to learn mappings .

2. Select Create configurationCreate configuration.

3. In the drop-down dialog box, in the NewNew  field group, select Format based on data model Model toFormat based on data model Model to

learn mappingslearn mappings .

4. In the NameName field, enter Format to learn mappingsFormat to learn mappings .

5. In the Data model definitionData model definition field, select Entr y point 1Entr y point 1 .

6. Select Create configurationCreate configuration.

Notice that draft version 1 of this ER configuration is ready for editing. This version contains the format

component.

1. On the ConfigurationsConfigurations  page, select DesignerDesigner .

2. Select Add rootAdd root.

3. In the TextText group, select the Str ingStr ing item.

4. Select OKOK.



 

Bind format elements to a data sourceBind format elements to a data source

Appendix 2
Configure a sample model mapping for general customizationConfigure a sample model mapping for general customization

Create an ER model mapping configurationCreate an ER model mapping configuration

Design a sample model mappingDesign a sample model mapping

1. On the Format designerFormat designer  page, on the MappingMapping tab, expand the model data source.

2. Select the Functionality descr iptionFunctionality descr iption field.

3. Select BindBind.

4. Select SaveSave.

5. Close the page.

You might want to customize a model mapping that a configuration provider (partner) provided to you, and

then use the customized version as a data source for your ER formats. In this case, you must create a custom ER

model mapping configuration to make the required changes in existing model mappings. The procedures in this

appendix use the Mapping (General)Mapping (General)  model mapping as an example.

1. On the ConfigurationsConfigurations  page, in the configurations tree, select Mapping (General)Mapping (General) .

2. Select Create configurationCreate configuration.

3. In the drop-down dialog box, in the NewNew  field group, select Derive from Name: Mapping (General),Derive from Name: Mapping (General),

L itware, Inc.L itware, Inc..

4. In the NameName field, enter Mapping (General) customMapping (General) custom.

5. Select Create configurationCreate configuration.

Notice that draft version 1 of this ER configuration is ready for editing.

1. On the ConfigurationsConfigurations  page, select DesignerDesigner .

Notice that the model mappings of the base configuration have been automatically copied to this

configuration.

2. Select the Mapping (General) CopyMapping (General) Copy  mapping.

3. Select DesignerDesigner .

4. In the Data modelData model  section, select EditEdit.

5. In the FormulaFormula field, enter "Generic functionality 1 custom""Generic functionality 1 custom".

6. Select SaveSave.

7. Close the page.



Complete the modified version of the model mapping configurationComplete the modified version of the model mapping configuration

8. Select SaveSave.

9. Close the page.

10. Select the Mapping (General) 2 CopyMapping (General) 2 Copy  mapping.

11. Select DesignerDesigner .

12. In the Data modelData model  section, select EditEdit.

13. In the FormulaFormula field, enter "Generic functionality 2 custom""Generic functionality 2 custom".

14. Select SaveSave.

15. Close the page.

16. Select SaveSave.

17. Close the page.

18. Close the page.

1. On the ConfigurationsConfigurations  page, on the VersionsVersions  FastTab, select Change statusChange status .

Change the status of designed model mapping configuration from DraftDraft to CompletedCompleted, so that it

can be used by ER formats.

2. Select CompleteComplete.



 Appendix 3
Configure a sample model mapping for country/region-specific customizationConfigure a sample model mapping for country/region-specific customization

Create an ER model mapping configurationCreate an ER model mapping configuration

Design a sample model mappingDesign a sample model mapping

3. Select OKOK.

Notice that the configuration that is created is saved as completed version 1.

For some ER formats, there might be country/region-specific requirements for data preparation. In this case,

you can manage a separate ER model mapping configuration and isolate the implementation of these

country/region-specific requirements from the general implementation. The procedures in this appendix use the

Format to learn mappingsFormat to learn mappings  ER format and French-specific requirements as an example.

First, create a new ER model mapping configuration to implement the country/region-specific requirements.

Use your custom ER model mapping configuration as a base.

1. On the ConfigurationsConfigurations  page, in the configurations tree, select Mapping (General) customMapping (General) custom.

2. Select Create configurationCreate configuration.

3. In the drop-down dialog box, in the NewNew  field group, select Derive from Name: Mapping (General)Derive from Name: Mapping (General)

custom, L itware, Inccustom, L itware, Inc.

4. In the NameName field, enter Mapping (FR)Mapping (FR) .

5. Select Create configurationCreate configuration.

Notice that draft version 1 of this ER configuration is ready for editing.

1. On the ConfigurationsConfigurations  page, select DesignerDesigner .

Notice that model mappings of the base configuration have been automatically copied to this

configuration.

2. Select the Mapping (General) Copy CopyMapping (General) Copy Copy  mapping.

3. Rename it Mapping (FR)Mapping (FR) .

4. Select DesignerDesigner .

5. In the Data modelData model  section, select EditEdit.

6. In the FormulaFormula field, enter "FR functionality 1""FR functionality 1".

7. Select SaveSave.

8. Close the page.

9. Select SaveSave.

10. Close the page.



Specify country/region context restrictions for useSpecify country/region context restrictions for use

Complete the modified version of the model mapping configurationComplete the modified version of the model mapping configuration

11. Select the Mapping (General) 2 Copy CopyMapping (General) 2 Copy Copy  mapping.

12. Rename it Mapping (FR) 2Mapping (FR) 2 .

13. Select DesignerDesigner .

14. In the Data modelData model  section, select EditEdit.

15. In the FormulaFormula field, enter "FR functionality 2""FR functionality 2".

16. Select SaveSave.

17. Close the page.

18. Select SaveSave.

19. Close the page.

20. Close the page.

1. On the ConfigurationsConfigurations  page, on the ISO Countr y/region codesISO Countr y/region codes  FastTab, select NewNew .

2. In the ISOISO field, select FRFR .

3. Select SaveSave.

Note that you must sign in to a specific company in Finance to run an ER format. Therefore, this company can be

considered a party that controls both ER format execution and selection of the correct ER model mapping of the

base ER data model. By adding the FRFR  country code, you specify that this model mapping is available for

selection by an ER format of the base data model only when that format is run under the control of a company

that has French country/region context.

You can add multiple country/region codes for a single version of an ER model mapping configuration. In this

way, model mappings that reside in that model mapping configuration can be used for an ER format that is run

under the control of companies that have a different country/region context.

Note that the list of country/region codes is specified for each version of an ER model mapping configuration

and can vary from version to version.

1. On the ConfigurationsConfigurations  page, on the VersionsVersions  FastTab, select Change statusChange status .

Change the status of designed model mapping configuration from DraftDraft to CompletedCompleted, so that it



Additional resources

Frequently asked questions
I configured two shared ER model mapping configurations in RCS and marked one of them as the default model mappingI configured two shared ER model mapping configurations in RCS and marked one of them as the default model mapping
configuration. I successfully ran an ER format that was created for the same base ER data model configuration, to test modelconfiguration. I successfully ran an ER format that was created for the same base ER data model configuration, to test model
mappings. I then imported the whole ER solution (ER data model, two ER model mapping configurations, and ER formatmappings. I then imported the whole ER solution (ER data model, two ER model mapping configurations, and ER format
configuration) into Finance. Why do I receive an error message when I try to run the same ER format in Finance?configuration) into Finance. Why do I receive an error message when I try to run the same ER format in Finance?

I configured one model mapping as a shared model mapping and completed the draft version of it. I then added a new modelI configured one model mapping as a shared model mapping and completed the draft version of it. I then added a new model
mapping configuration for same data model and configured it as French-specific. Why is the shared model mapping selected whenmapping configuration for same data model and configured it as French-specific. Why is the shared model mapping selected when
I run an ER format, even though this ER format uses the correct root definition and execution is done under the control of theI run an ER format, even though this ER format uses the correct root definition and execution is done under the control of the
company that has French country/region context?company that has French country/region context?

NOTENOTE

can be used by ER formats.

2. Select CompleteComplete.

3. Select OKOK.

Notice that the configuration that is created is saved as completed version 1.

Electronic reporting (ER) overview

Manage ER model mapping in separate ER configurations

Apply country/region context

The default model mapping setting is environment-specific. It's configured in RCS but isn't exported to Finance.

To successfully run this ER format, you must mark one of ER model mapping configurations as the default

model mapping configuration in Finance too.

Make sure that the shared model mapping configuration isn't marked as the default model mapping

configuration. Otherwise, it will have higher priority during mapping selection. Also make sure that the French-

specific model mapping configuration is considered when a mapping is selected during ER format execution. An

ER model mapping configuration is available for selection only if at least one of the following conditions is met:

At least one version of the ER model mapping configuration has either CompletedCompleted or SharedShared status. In this

case, the version that has the highest version number will be used for ER format execution.

The Run draftRun draft option for the ER model mapping configuration is turned on. In this case, the version that has

DraftDraft status will be used for ER format execution.

The Run draftRun draft option becomes available on the ConfigurationsConfigurations  page for each ER model mapping

configuration when the Run settingRun setting ER user parameter is turned on.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lcs-solutions/apply-country-context
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Configure ER formats to use parameters that are
specified per legal entity
2/18/2021 • 13 minutes to read • Edit Online

Overview

Prerequisites

Import ER configurations into RCS

In many of the Electronic reporting (ER) formats that you will design, you must filter data by using a set of

values that are specific to each legal entity of your instance (for example, a set of tax codes to filter tax

transactions). Currently, when filtering of this type is configured in an ER format, values that are dependent on

the legal entity (for example, tax codes) are used in expressions of the ER format to specify data filtering rules.

Therefore, the ER format is made legal entity–specific, and to generate the required reports, you must create

derived copies of the original ER format for each legal entity where you have to run the ER format. Each derived

ER format must be edited to bring legal entity–specific values into it, rebased whenever the original (base)

version has been updated, exported from a test environment and imported into a production environment

when it must be deployed for production use, and so on. Therefore, maintenance of this type of configured ER

solution is quite complex and time-consuming for several reasons:

The more legal entities there are, the more ER format configurations must be maintained.

Maintenance of ER configurations requires that business users have ER knowledge.

The ER application-specific parameters feature lets power users configure data filtering in an ER format so that

it's based on a set of abstract rules. This set of rules can be configured to use the data sources that are available

in an ER format. Business users can then specify real rules beyond the ER framework by using the user interface

(UI) that is automatically generated based on the settings of the corresponding ER format and the current legal

entity data that will be accessed by the ER format's data sources. The set of rules that is specified for an ER

format can be exported from the current legal entity of the Dynamics 365 Finance (Finance) instance. It can then

be imported into another legal entity of either the same Finance instance or a different instance as a set of rules

for the same ER format.

To complete the examples in this topic, you must have access to the instance of Regulatory Configuration

Services (RCS) that has been provisioned for the same tenant as Finance for one of the following roles:

Electronic reporting developer

Electronic reporting functional consultant

System administrator

We recommend that you complete the steps in the Support parameterized calls of ER data sources of

CALCULATED FIELD type topic. If you've already completed those steps, you can skip the steps in the Impor t ERImpor t ER

configurations into RCSconfigurations into RCS  section that follows.

From Microsoft Download Center, download the Suppor t parameter ized calls of ER data sources ofSuppor t parameter ized calls of ER data sources of

CALCUL ATED FIELD typeCALCUL ATED FIELD type zip file. This zip file contains the following ER configurations that must be extracted

and stored locally.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-app-specific-parameters-configure-format.md
https://go.microsoft.com/fwlink/?linkid=851448


C O N T EN T  DESC RIP T IO NC O N T EN T  DESC RIP T IO N F IL E  N A M EF IL E  N A M E

Sample ER data modelER data model configuration file Model to learn parameterized calls.version.1.xml

Sample ER metadataER metadata configuration file Metadata to learn parameterized calls.version.1.xml

Sample ER model mappingER model mapping configuration file Mapping to learn parameterized calls.version.1.1.xml

Sample ER formatER format  configuration Format to learn parameterized calls.version.1.1.xml

Review the ER solution that is provided

Next, sign in to your RCS instance.

In this example, you will create a configuration for the Litware, Inc sample company. Before you can complete

this procedure, you must complete the steps in the Create a configuration provider and mark it as active topic in

RCS.

1. On the default dashboard, select Electronic repor tingElectronic repor ting.

2. Select Repor ting configurationsRepor ting configurations .

3. Import the ER configurations that you downloaded earlier into RCS, in the following order : data model,

metadata, model mapping, and format. For each ER configuration, follow these steps:

a. Select ExchangeExchange.

b. Select Load from XML fileLoad from XML file.

c. Select BrowseBrowse to select the file for the required ER configuration in XML format.

d. Select OKOK.

1. In the configuration tree, expand the contents of the Model to learn parameter ized callsModel to learn parameter ized calls  item.

2. Select the Format to learn parameter ized callsFormat to learn parameter ized calls  item.

3. Select DesignerDesigner .

4. Select Expand/CollapseExpand/Collapse.

The Format to learn parameter ized callsFormat to learn parameter ized calls  ER format is designed to generate a tax statement in XML

format that presents several levels of taxation (regular, reduced, and none). Each level has a different

number of details.

5. On the MappingMapping tab, expand the ModelModel , DataData, and Summar ySummar y  items.



Create a derived format

The Model.Data.Summar yModel.Data.Summar y  data source returns the list of tax transactions. These transactions are

summarized by tax code. For this data source, the Model.Data.Summar y.LevelModel.Data.Summar y.Level  calculated field has

been configured to return the code for the taxation level of each summarized record. For any tax code

that can be retrieved from the Model.Data.Summar yModel.Data.Summar y  data source at runtime, the calculated field

returns the taxation level code (RegularRegular , ReducedReduced, NoneNone, or OtherOther ) as a text value. The

Model.Data.Summar y.LevelModel.Data.Summar y.Level  calculated field is used to filter records of the Model.Data.Summar yModel.Data.Summar y

data source and enter the filtered data in each XML element that represents a taxation level by using the

Model.Data2.Level1Model.Data2.Level1 , Model.Data2.Level2Model.Data2.Level2 , and Model.Data2.Level3Model.Data2.Level3  fields.

The Model.Data.Summar y.LevelModel.Data.Summar y.Level  calculated field has been configured so that it contains an ER

expression. Note that tax codes (VAT19VAT19 , InVAT19InVAT19 , VAT7VAT7 , InVAT7InVAT7 , THIRDTHIRD, and InVAT0InVAT0 ) are hardcoded

into this configuration. Therefore, this ER format is dependent on the legal entity where these tax codes

were configured.

To support a different set of tax codes for each legal entity, you must follow these steps:

Create a derived version of the ER format for each legal entity.

Update the tax codes in the Model.Data.Summar y.LevelModel.Data.Summar y.Level  calculated field, based on the legal entity

setting.

6. Close the Format designerFormat designer  page.

Next, you will use the ER application-specific parameters feature to support a different set of tax codes for each



Configure a derived format
Add a format enumerationAdd a format enumeration

legal entity in a single ER format.

1. In the configuration tree, expand the contents of the Model to learn parameter ized callsModel to learn parameter ized calls  item.

2. Select the Format to learn parameter ized callsFormat to learn parameter ized calls  item.

3. Select Create configurationCreate configuration.

4. Select the Derive from Name: Format to learn parameter ized calls , MicrosoftDerive from Name: Format to learn parameter ized calls , Microsoft option.

5. In the NameName field, enter Format to learn how to lookup LE dataFormat to learn how to lookup LE data.

6. Select Create configurationCreate configuration.

Next, you will add a new ER format enumeration. The values of this format enumeration will be presented to

business users, who will specify legal entity–dependent sets of tax codes for the various taxation levels that are

used in the ER format.

1. Select DesignerDesigner .

2. Select Format enumerationsFormat enumerations .

3. Select AddAdd.

4. In the NameName field, enter L ist of taxation levelsL ist of taxation levels .

5. Select SaveSave.

6. On the Format enumeration valuesFormat enumeration values  tab, select AddAdd.

7. In the NameName field, enter Regular taxationRegular taxation.

8. Select AddAdd again.

9. In the NameName field, enter Reduced taxationReduced taxation.

10. Select AddAdd again.

11. In the NameName field, enter No taxationNo taxation.

12. Select AddAdd again.

13. In the NameName field, enter OtherOther .



Because the business users might use different languages to specify legal entity–dependent sets of tax

codes, we recommend that you translate the values of this enumeration into the languages that are

configured as the preferred languages for those users in Finance.

14. Select the No taxationNo taxation record.

15. Click in the LabelLabel  field.

16. Select TranslateTranslate.

17. In the Text translationText translation pane, in the Label IdLabel Id field, enter LBL_LEVELENUM_NOLBL_LEVELENUM_NO.

18. In the Text in default languageText in default language field, enter No taxationNo taxation.

19. In the LanguageLanguage field, select DEDE.

20. In the Translated textTranslated text field, enter keine Besteuerungkeine Besteuerung.

21. Select TranslateTranslate.



Add a new lookup data sourceAdd a new lookup data source

22. Select SaveSave.

23. Close the Format enumerationsFormat enumerations  page.

Next, you will add a new data source to specify how business users will specify legal entity–dependent rules to

recognize the correct taxation level for each summarized transaction record.

1. On the MappingMapping tab, select AddAdd.

2. Select Format enumeration\LookupFormat enumeration\Lookup.

You just identified that each rule that business users specify for taxation level recognition will return a

value of an ER format enumeration. Notice that the LookupLookup data source type can be accessed under the

Data modelData model  and Dynamics 365 for OperationsDynamics 365 for Operations  blocks in addition to the Format enumerationFormat enumeration

block. Therefore, ER data model enumerations and application enumerations can be used to specify the

type of values that is are returned for data sources of that type.

3. In the NameName field, enter SelectorSelector .

4. In the Format enumerationFormat enumeration field, select L ist of taxation levelsL ist of taxation levels .

You just specified that, for each rule that is specified in this data source, a business user must select one of

the values of the L ist of taxation levelsL ist of taxation levels  format enumeration as a returned value.

5. Select Edit lookupEdit lookup.

6. Select ColumnsColumns .

7. Expand the ModelModel  item.

8. Expand the DataData item.

9. Expand the TaxTax item.

10. Select the Model.Data.Tax.CodeModel.Data.Tax.Code item.

11. Select the AddAdd button (the right arrow).

You just specified that, for each rule that is specified in this data source for taxation level recognition, a

business user must select one of the tax codes as a condition. The list of tax codes that the business user

can select will be returned by the Model.Data.TaxModel.Data.Tax data source. Because this data source contains the

NameName field, the name of the tax code will be shown for each tax code value in the lookup that is

presented to the business user.

12. Select OKOK.



Business users can add multiple rules as records of this data source. Each record will be numbered by a

line code. Rules will be evaluated in order of increasing line number.

Because you selected the Tax codeTax code field as a condition for rules in this lookup data source, and because

Tax codeTax code is set up as a field of the Str ingStr ing data type, each rule will be evaluated at runtime by comparing

the tax code that is passed to the data source with the tax code that is defined in this record of the data

source.

When a rule that satisfies the configured condition is found, this data source returns the lookup value of

the rule that is defined in the Lookup resultLookup result field. If no rule is found, an exception is thrown to notify the

user that the current data source can't return a correct value.

13. Select SaveSave.

14. Close the Lookup designerLookup designer  page.

15. Select OKOK.

Notice that you added a new data source that will return the taxation level as the value of the L ist ofL ist of

taxation levelstaxation levels  format enumeration for any tax code that is passed to the data source as the argument

of the CodeCode parameter of the Str ingStr ing data type.

Note that the evaluation of configured rules depends on the data type of the fields that have been

selected to define conditions of those rules. When you select a field that is configured as a field of either

the NumericNumeric or DateDate data type, the criteria will differ from the criteria that were described earlier for the

Str ingStr ing data type. For NumericNumeric and DateDate fields, the rule must be specified as a range of values. The

condition of the rule will then be considered satisfied when a value that is passed to the data source is in

the configured range.

The following illustration shows an example of this type of setup. In addition to the

Model.Data.Tax.CodeModel.Data.Tax.Code field of the Str ingStr ing data type, the Model.Tax.Summar y.BaseModel.Tax.Summar y.Base field of the RealReal

data type is used to specify conditions for a lookup data source.



Translate the label of the lookup data source that was addedTranslate the label of the lookup data source that was added

Because the Model.Data.Tax.CodeModel.Data.Tax.Code and Model.Tax.Summar y.BaseModel.Tax.Summar y.Base fields are selected for this lookup

data source, each rule of this data source will be configured in the following way:

In the list that is presented, the value of the L ist of taxation levelsL ist of taxation levels  format enumeration must be

selected as a returned value.

The tax code must be entered as a condition of this rule. Only tax codes that are provided by the

Model.Data.TaxModel.Data.Tax data source are applicable.

Minimum and maximum values of the tax base amount must be entered as conditions of this rule.

Here is how each rule of this data source will be evaluated at runtime:

Does the code of the Str ingStr ing data type that was passed to this data source equal the tax code of a rule?

Does the value of the RealReal  data type that was passed to this data source fall between specific

minimum and maximum values?

A rule will be considered applicable when both conditions are satisfied.

Because business users might use different languages to specify legal entity–dependent sets of tax codes, we

recommend that you translate the label of any lookup data source that you add, so that it's presented in each

user's preferred language on the corresponding page.

1. Select the Model.Data.SelectorModel.Data.Selector  data source.

2. Select EditEdit.

3. Click in the LabelLabel  field.

4. Select TranslateTranslate.

5. In the Text translationText translation pane, in the Label IdLabel Id field, enter LBL_SELECTOR_DSLBL_SELECTOR_DS .

6. In the Text in default languageText in default language field, enter Select tax level by tax codeSelect tax level by tax code.

7. In the LanguageLanguage field, select DEDE.

8. In the Translated textTranslated text field, enter Steuerebene für Steuerkennzeichen auswählenSteuerebene für Steuerkennzeichen auswählen.

9. Select TranslateTranslate.

10. Select OKOK.



Add a new field to consume the configured lookupAdd a new field to consume the configured lookup
1. Expand the Model.DataModel.Data item.

2. Select the Model.Data.Summar yModel.Data.Summar y  item.

3. Select AddAdd.

4. Select Functions/Calculated fieldFunctions/Calculated field.

5. In the NameName field, enter LevelByLookupLevelByLookup.

6. Select Edit formulaEdit formula.

7. In the Formula fieldFormula field, enter Model.Selector(Model.Data.Summar y.Code)Model.Selector(Model.Data.Summar y.Code) .

8. Select SaveSave.

9. Close the Formula editorFormula editor  page.

10. Select OKOK.



Add a new format enumeration-based data sourceAdd a new format enumeration-based data source

Modify an existing field to start to use the lookupModify an existing field to start to use the lookup

Notice that the LevelByLookupLevelByLookup calculated field that you added will return the taxation level as the value

of the L ist of taxation levelsL ist of taxation levels  format enumeration for each summarized tax transactions record. The tax

code of the record will be passed to the Model.SelectorModel.Selector  lookup data source, and the set of rules for this

data source will be used to select the correct taxation level.

Next, you will add a new data source that refers to the format enumeration that you added earlier. Values of this

data source will be used in an ER format expression later.

1. Select Add rootAdd root.

2. Select Format enumerations\EnumerationFormat enumerations\Enumeration.

3. In the NameName field, enter TaxationLevelTaxationLevel .

4. In the Format enumerationFormat enumeration field, select L ist of taxation levelsL ist of taxation levels .

5. Select SaveSave.

Next, you will modify the existing calculated field so that it uses the configured lookup data source to return the

correct taxation level value, depending on the tax code.

1. Select the Model.Data.Summar y.LevelModel.Data.Summar y.Level  item.

2. Select EditEdit.

3. Select Edit formulaEdit formula.

Notice that the current expression of the Model.Data.Summar y.LevelModel.Data.Summar y.Level  field includes the following hard-

coded tax codes:

CASE (@.Code, "VAT19", "Regular", "InVAT19", "Regular", "VAT7", "Reduced", "InVAT7", "Reduced", "THIRD",

"None", "InVAT0", "None", "Other")

4. In the FormulaFormula field, enter CASE(@.LevelByLookup, TaxationLevel.'Regular taxation' , "Regular",CASE(@.LevelByLookup, TaxationLevel.'Regular taxation' , "Regular",

TaxationLevel.'Reduced taxation' , "Reduced", TaxationLevel.'No taxation' , "None", "Other")TaxationLevel.'Reduced taxation' , "Reduced", TaxationLevel.'No taxation' , "None", "Other") .



Complete the draft version of a derived format

Export completed version of modified format

Notice that the expression of the Model.Data.Summar y.LevelModel.Data.Summar y.Level  field will now return the taxation level,

based on the tax code of the current record and the set of rules that that a business user configures in the

Model.Data.SelectorModel.Data.Selector  lookup data source.

5. Select SaveSave.

6. Close Formula designerFormula designer  page.

7. Select OKOK.

8. Select SaveSave.

9. Close Format designerFormat designer  page.

1. On the VersionsVersions  fast tab, select Change statusChange status .

2. Select CompleteComplete.

3. Select OKOK.

1. In the configuration tree, select the Format to learn how to lookup LE dataFormat to learn how to lookup LE data item.

2. On the VersionsVersions  fast tab, select the record that has a status of CompletedCompleted.

3. Select ExchangeExchange.

4. Select Expor t as XML fileExpor t as XML file.

5. Select OKOK.

6. The web browser downloads a Format to learn how to lookup LE data.xmlFormat to learn how to lookup LE data.xml  file. Store this file locally.

Repeat steps in this section for parent items of the Format to learn how to lookup LE dataFormat to learn how to lookup LE data format, and store

the following files locally:

Format to learn parameterized calls.xml

Mapping to learn parameterized calls.xml

Model to learn parameterized calls.xml

To learn how to use the configured Format to learn how to lookup LE dataFormat to learn how to lookup LE data ER format to set up legal entity–

dependent sets of tax codes to filter tax transactions by different taxation levels, complete the steps in the Set up

the parameters of an ER format per legal entity topic.



Additional resources
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Set up the parameters of an ER format per legal
entity
2/18/2021 • 9 minutes to read • Edit Online

Prerequisites

Import ER configurations

Set up parameters for the DEMF company

To complete these steps, you must first complete the steps in the Configure ER formats to use parameters that

are specified per legal entity topic.

To complete the examples in this topic, you must have access to Microsoft Dynamics 365 Finance (Finance) for

one of the following roles:

Electronic reporting developer

Electronic reporting functional consultant

System administrator

1. Sign in to your environment.

2. On the default dashboard, select Electronic repor tingElectronic repor ting.

3. Select Repor ting configurationsRepor ting configurations .

4. Import, into the current instance of Finance, the configurations that you exported from Regulatory

Configuration Services (RCS) while you were completing the steps in the Configure ER formats to use

parameters that are specified per legal entity topic. Follow these steps for each Electronic reporting (ER)

configuration, in the following order : data model, model mapping, and formats.

a. Select Exchange > Load from XML fileExchange > Load from XML file.

b. Select BrowseBrowse to select the file for the required ER configuration in XML format.

c. Select OKOK.

The following illustration shows the configurations that you must have when you've finished.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-app-specific-parameters-set-up.md


You can use the ER framework to set up application-specific parameters for an ER format.

1. Select the DEMFDEMF legal entity.

2. In the configurations tree, select the Format to learn how to lookup LE dataFormat to learn how to lookup LE data format.

3. On the Action Pane, on the ConfigurationsConfigurations  tab, in the Application specific parametersApplication specific parameters  group, select

SetupSetup.

On the Application specific parametersApplication specific parameters  page, you can configure the rules for the SelectorSelector  data

source of the Format to learn how to lookup LE dataFormat to learn how to lookup LE data format.

If the base ER format will contain several data sources of the LookupLookup type, you must select the desired

data source on the LookupsLookups  FastTab before you can start to configure the set of rules for the data source.

For each data source, you can configure separate rules for each version of the selected ER format.

The whole set of rules for all lookup data sources that are available in the selected version of the base ER

format makes up the application-specific parameters for the ER format.

4. Select version 1.1 .11.1 .1  of the ER format.

5. On the ConditionsConditions  FastTab, select AddAdd.

6. In the CodeCode field of the new record, select the drop-down arrow to open the lookup.

The lookup presents the list of tax codes for selection. This list is returned by the Model.Data.TaxModel.Data.Tax data

source that has been configured in the base ER format. Because this data source contains the NameName field,

the name of each tax code appears in the lookup.



7. Select the VAT19VAT19  tax code.

8. In the Lookup resultLookup result field of the new record, select the drop-down arrow to open the lookup. The

lookup presents the list of values for the TaxationLevel format enumeration for selection.

Note that, if German is selected as the preferred language of the user that you're signed in as, the labels

of the values in the lookup will be in German, provided that they have been translated in the base ER

format. Additionally, if the label of a lookup data source has been translated, that label will appear in the

user's preferred language on the LookupsLookups  tab.

9. Select the Regular taxationRegular taxation value.

By adding this record, you define the following rule: Whenever the SelectorSelector  lookup data source is



requested, and the VAT19VAT19  tax code is passed as an argument, Regular taxationRegular taxation will be returned as the

requested taxation level.

10. Select AddAdd, and then follow these steps:

a. In the CodeCode field, select the InVAT19InVAT19  tax code.

b. In the Lookup resultLookup result field, select the Regular taxationRegular taxation value.

11. Select AddAdd again, and then follow these steps:

a. In the CodeCode field, select the VAT7VAT7  tax code.

b. In the Lookup resultLookup result field, select the Reduced taxationReduced taxation value.

12. Select AddAdd again, and then follow these steps:

a. In the CodeCode field, select the InVAT7InVAT7  tax code.

b. In the Lookup resultLookup result field, select the Reduced taxationReduced taxation value.

13. Select AddAdd again, and then follow these steps:

a. In the CodeCode field, select the THIRDTHIRD tax code.

b. In the Lookup resultLookup result field, select the No taxationNo taxation value.

14. Select AddAdd again, and then follow these steps:

a. In the CodeCode field, select the InVAT0InVAT0  tax code.

b. In the Lookup resultLookup result field, select the No taxationNo taxation value.

15. Select AddAdd again, and then follow these steps:

a. In the CodeCode field, select the *Not blank**Not blank*  option.

b. In the Lookup resultLookup result field, select the OtherOther  value.

By adding this last record, you define the following rule: Whenever the tax code that is passed as an

argument doesn't satisfy any of the previous rules, the lookup data source will return OtherOther  as the

requested taxation level.

16. In the StateState field, select CompletedCompleted.

When you run an ER format version that has a status of either CompletedCompleted or SharedShared, this set of rules

must be in the CompletedCompleted state. Otherwise, execution of the base ER format will be interrupted when

the format tries to load data from this set of rules while the SelectorSelector  lookup data source is being run.



Run the ER format in the DEMF company

Set up parameters for the USMF company

When you run an ER format version that has a status of DraftDraft, the base ER format can access this set of

rules, regardless of its state.

17. Select SaveSave.

18. Close the Application specific parametersApplication specific parameters  page.

1. In the configurations tree, select the Format to learn how to lookup LE dataFormat to learn how to lookup LE data format.

2. On the Action Pane, select RunRun.

3. In the dialog box that appears, select OKOK.

4. Download the statement that is generated and store it locally.

In the generated statement, notice that the summary of the InVAT7InVAT7  tax code has been put on the

ReducedReduced level, and the summaries of the VAT19VAT19  and InVA19InVA19  tax codes have been put on the RegularRegular

level. This behavior is determined by the configuration in the legal entity–dependent set of rules.

5. Go to Tax > Indirect taxes > Sales tax > Sales tax codesTax > Indirect taxes > Sales tax > Sales tax codes .

6. Select the InVAT7InVAT7  tax code.

7. On the Action Pane, on the Sales tax codeSales tax code tab, in the Inquir iesInquir ies  group, select Posted sales taxPosted sales tax to view

information about the tax value and applied tax rate per tax code.

8. Close the Posted sales tax page.

1. Select the USMFUSMF legal entity.

2. Go to Organization administration > Electronic repor ting > ConfigurationsOrganization administration > Electronic repor ting > Configurations .

3. In the configurations tree, expand the Model to learn parameter ized callsModel to learn parameter ized calls  item, expand the FormatFormat

to learn parameter ized callsto learn parameter ized calls  item, and select the Format to learn how to lookup LE dataFormat to learn how to lookup LE data format.

4. On the Action Pane, on the ConfigurationsConfigurations  tab, in the Application specific parametersApplication specific parameters  group, select



SetupSetup.

5. Select version 1.1 .11.1 .1  of the selected ER format.

6. On the ConditionsConditions  FastTab, select AddAdd.

7. In the CodeCode field of the new record, select the drop-down arrow to open the lookup.

The lookup now presents the list of tax codes for the USMFUSMF company tax for selection.

8. Select the EXEMPTEXEMPT tax code.

9. In the Lookup resulLookup resul t field of the new record, select the No taxationNo taxation value.

10. Select AddAdd again.

11. In the CodeCode field of the new record, select the *Not blank**Not blank*  option.

12. In the Lookup resultLookup result field of the new record, select the Regular taxationRegular taxation value.

13. In the StateState field, select CompletedCompleted.

14. Select SaveSave.



Run the ER format in the USMF company

Reuse legal entity–dependent parameters
Export parametersExport parameters

Import parametersImport parameters

15. Close the Application specific parametersApplication specific parameters  page.

1. In the configurations tree, select the Format to learn how to lookup LE dataFormat to learn how to lookup LE data format.

2. On the Action Pane, select RunRun.

3. In the dialog box that appears, select OKOK.

4. Download the statement that is generated and store it locally.

In the generated statement, notice that you've now reused the same ER format for a different legal entity,

but without making any adjustments to the ER format.

1. Go to Organization administration > Workspaces > Electronic repor tingOrganization administration > Workspaces > Electronic repor ting.

2. Select Repor ting configurationsRepor ting configurations .

3. In the configurations tree, select the Format to learn how to lookup LE dataFormat to learn how to lookup LE data format.

4. On the Action Pane, on the ConfigurationsConfigurations  tab, in the Application specific parametersApplication specific parameters  group, select

SetupSetup.

5. Select version 1.1 .11.1 .1  of the ER format.

6. On the Action Pane, select Expor tExpor t.

7. Download the file that is generated and store it locally.

The configured set of application-specific parameters has now been exported as an XML file.

1. Select version 1.1 .21.1 .2  of the ER format.

2. On the Action Pane, select Impor tImpor t.



Relationship between application-specific parameters and an ER
format

Access application-specific parameters by using the ER framework

3. Select YesYes  to confirm that you want to override the existing application-specific parameters for this

format version.

4. Select BrowseBrowse to find the file that contains the exported application-specific parameters for version

1.1.11.1 .1 .

5. Select OKOK.

Version 1.1 .21.1 .2  of the ER format now has the same application-specific parameters that you originally

configured for version 1.1 .11.1 .1 .

Note that the application-specific parameters of an ER format are legal entity–dependent. To reuse the

application-specific parameters that were configured for one legal entity in a different legal entity, you

must export them while you're signed in to the first legal entity and then import them after you sign in to

the other legal entity.

You can also use this approach to transfer an ER format related application-specific parameters that were

originally configured in one instance of Finance to another instance of Finance.

Be aware that if you configure application-specific parameters for one version of an ER format and

import a higher version of the same format into the current Finance instance, the existing application-

specific parameters won't be applied for the imported version.

Also be aware that, when you select a file for import, the structure of the application-specific parameters

in that file is compared with the structure of the corresponding data source of the LookupLookup type in the ER

format that is selected for import. The import is done when the structure of each application-specific

parameter matches the structure of the corresponding data source in the ER format that is selected for

import. If the structures don't match, you receive a warning message that states that the import can't be

done. If you force the import to be done, the existing application-specific parameters for the selected ER

format will be cleaned up, and you must set them up from the beginning.

The relationship between an ER format and its application-specific parameters is established by the ER format's

instance-independent unique identification code. Therefore, when you remove an ER format from Finance, the

application-specific parameters that are configured for the ER format are kept in the current instance of Finance.

They can be accessed whenever the base ER format is reimported into this instance of Finance.

In the preceding example, you have accessed application-specific parameters of an ER format by using the ER

framework. This approach doesn't let you restrict access to the application-specific parameters of a specific ER

format. If you must apply such restrictions, follow these steps.

1. Either reuse an existing ERSolutionAppSpecificParametersDesignerERSolutionAppSpecificParametersDesigner  menu item, or implement your

own ERSolutionAppSpecificParametersDesignerERSolutionAppSpecificParametersDesigner  menu item.



2. Follow one of these steps:

a. Create a new menu item button, and link it to the corresponding record from the

ERSolutionTableERSolutionTable table by setting its Data SourceData Source property to ERSolutionTableERSolutionTable.

b. Create a simple button, and override the ClickedClicked method as shown in the following example.

By using this approach, you can specify a unique solution ID (defined via the GUIDGUID value) to allow

access to the application-specific parameters of only a specific ER format and descendant copies

that have been derived from it.



Additional resources

NOTENOTE

public void clicked()
    {
        super();

        ERSolutionTable solutionTableRecord = ERSolutionTable::findByGUID(str2Guid('ADACCB2F-
EFD1-4C90-877D-7E1E5D1AEE92'));

        Args args = new Args();
        args.record(solutionTableRecord);
        args.caller(this);

        new MenuFunction(menuItemDisplayStr(ERSolutionAppSpecificParametersDesigner), 
MenuItemType::Display)
            .run(args);
    }

Formula designer in Electronic reporting

Configure ER formats to use parameters that are specified per legal entity
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Overview

Limitations

Example: Defer the execution of a sequence element in an ER format

PrerequisitesPrerequisites

C O N T EN T  DESC RIP T IO NC O N T EN T  DESC RIP T IO N F IL E  N A M EF IL E  N A M E

ER data model configuration Model to learn deferred elements.version.1.xml

ER model mapping configuration Mapping to learn deferred elements.version.1.1.xml

You can use the Operations designer of the Electronic reporting (ER) framework to configure the format

component of an ER solution that is used to generate outbound documents in a text format. The hierarchical

structure of the configured format component consists of format elements of various types. These format

elements are used to fill generated documents with the required information at runtime. By default, when you

run an ER format, the format elements are run in the same order as they are presented in the format hierarchy:

one by one, from top to bottom. However, at design time, you can change the execution order for any sequence

elements of the configured format component.

 By turning on the Deferred executionDeferred execution option for a sequence format element in the configured format, you can

defer (postpone) the execution of that element. In this case, the element isn't run until all other elements of its

parent have been run.

To learn more about this feature, complete the example in this topic.

The Deferred executionDeferred execution option is supported only for sequence elements that are configured for an ER format

that is used to generate outboundoutbound documents in text format.

The Deferred executionDeferred execution option isn't applicable to sequences that have been configured as trimmed sequences

where the maximum length is limited.

The following steps explain how a user in the System administrator or Electronic reporting functional consultant

role can configure an ER format that contains a sequence element where order of execution differs from the

order in the format hierarchy.

These steps can be performed in the USMFUSMF company in Microsoft Dynamics 365 Finance.

To complete this example, you must have access to the USMFUSMF company in Finance for one of the following roles:

Electronic reporting functional consultant

System administrator

If you haven't yet completed the example in the Defer the execution of XML elements in ER formats topic,

download the following configurations of the sample ER solution.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-defer-sequence-element.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/sysadmin/tasks/assign-users-security-roles
https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg
https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg


C O N T EN T  DESC RIP T IO NC O N T EN T  DESC RIP T IO N F IL E  N A M EF IL E  N A M E

ER format configuration Format to learn deferred sequences.version.1.1.xml

Import the sample ER configurationsImport the sample ER configurations

Activate a configurations providerActivate a configurations provider

Before you begin, you must also download and save the following configuration of the sample ER solution.

1. Go to Organization administrationOrganization administration > WorkspacesWorkspaces  > Electronic repor tingElectronic repor ting.

2. Select Repor ting configurationsRepor ting configurations .

3. On the ConfigurationsConfigurations  page, if the Model to learn deferred elementsModel to learn deferred elements  configuration isn't available in

the configuration tree, import the ER data model configuration:

a. Select ExchangeExchange, and then select Load from XML fileLoad from XML file.

b. Select BrowseBrowse, find and select the Model to learn deferred elements.1 .xmlModel to learn deferred elements.1 .xml  file, and then select

OKOK.

4. If the Mapping to learn deferred elementsMapping to learn deferred elements  configuration isn't available in the configuration tree,

import the ER model mapping configuration:

a. Select ExchangeExchange, and then select Load from XML fileLoad from XML file.

b. Select BrowseBrowse, find and select the Mapping to learn deferred elements.1 .1 .xmlMapping to learn deferred elements.1 .1 .xml  file, and then

select OKOK.

5. Import the ER format configuration:

a. Select ExchangeExchange, and then select Load from XML fileLoad from XML file.

b. Select BrowseBrowse, find and select the Format to learn deferred sequences.1 .1 .xmlFormat to learn deferred sequences.1 .1 .xml  file, and then

select OKOK.

6. In the configuration tree, expand Model to learn deferred elementsModel to learn deferred elements .

7. Review the list of imported ER configurations in the configuration tree.

1. Go to Organization administrationOrganization administration > WorkspacesWorkspaces  > Electronic repor tingElectronic repor ting.

2. On the Localization configurationsLocalization configurations  page, in the Configuration providersConfiguration providers  section, make sure that

the configuration provider for the Litware, Inc. ( http://www.litware.com ) sample company is listed, and

that it's marked as active. If this configuration provider isn't listed, or if it isn't marked as active, follow the

steps in the Create a configuration provider and mark it as active topic.

https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg


Review the imported model mappingReview the imported model mapping
Review the settings of the ER model mapping component that is configured to access tax transactions and

expose accessed data on request.

1. Go to Organization administrationOrganization administration > WorkspacesWorkspaces  > Electronic repor tingElectronic repor ting.

2. Select Repor ting configurationsRepor ting configurations .

3. On the ConfigurationsConfigurations  page, in the configuration tree, expand Model to learn deferred elementsModel to learn deferred elements .

4. Select the Mapping to learn deferred elementsMapping to learn deferred elements  configuration.

5. Select DesignerDesigner  to open the list of mappings.

6. Select DesignerDesigner  to review the mapping details.

7. Select Show detailsShow details .

8. Review the data sources that are configured to access tax transactions:

The TransactionsTransactions  data source of the Table record type is configured to access records of the

TaxTransTaxTrans  application table.

The VouchersVouchers  data source of the Calculated field type is configured to return the required voucher

codes (INV-10000349INV-10000349  and INV-10000350INV-10000350 ) as a list of records.

The FilteredFiltered data source of the Calculated field type is configured to select, from the

TransactionsTransactions  data source, only tax transactions of the required vouchers.

The $TaxAmount$TaxAmount field of the Calculated field type is added for the FilteredFiltered data source to expose

the tax value that has the opposite sign.

The GroupedGrouped data source of the Group By type is configured to group filtered tax transactions of

the FilteredFiltered data source.

The TotalSumTotalSum aggregation field of the GroupedGrouped data source is configured to summarize values

of the $TaxAmount$TaxAmount field of the FilteredFiltered data source for all filtered tax transactions of that data

source.



Review the imported formatReview the imported format

9. Review how the configured data sources are bound to the data model, and how they expose accessed

data to make it available in an ER format:

The FilteredFiltered data source is bound to the Data.L istData.L ist field of the data model.

The $TaxAmount$TaxAmount field of the FilteredFiltered data source is bound to the Data.L ist.ValueData.L ist.Value field of the data

model.

The TotalSumTotalSum field of the GroupedGrouped data source is bound to the Data.Summar y.TotalData.Summar y.Total  field of the

data model.

10. Close the Model mapping designerModel mapping designer  and Model mappingsModel mappings  pages.

1. On the ConfigurationsConfigurations  page, in the configuration tree, select the Format to learn deferredFormat to learn deferred

sequencessequences  configuration.

2. Select DesignerDesigner  to review the format details.

3. Select Show detailsShow details .

4. Review the settings of the ER format components that are configured to generate an outbound document

in text format that includes details of the tax transactions:

The Repor t\L inesRepor t\L ines  sequence format element is configured to fill the outbound document with a

single line that is generated from the nested sequence elements (HeaderHeader , RecordRecord, and

Summar ySummar y ).



The Repor t\L ines\HeaderRepor t\L ines\Header  sequence format element is configured to fill the outbound document

with a single header line that shows the date and time when the processing starts.

The Repor t \L ines\RecordRepor t \L ines\Record sequence format element is configured to fill the outbound document

with a single line that shows the details of individual tax transactions. These tax transactions are

separated by a semicolon.

The Repor t\L ines\Summar yRepor t\L ines\Summar y  sequence format element is configured to fill the outbound

document with a single summary line that includes the sum of the tax values from the processed

tax transactions.

5. On the MappingMapping tab, review the following details:

The Repor t\L ines\HeaderRepor t\L ines\Header  element doesn't have to be bound to a data source to generate a single

line in an outbound document.

The Prefix1Prefix1  element generates P1P1  symbols to indicate that the line that is added is the report header

line.

The ExecutionDateTimeExecutionDateTime element generates the date and time (including milliseconds) when the

header line is added.



Run the imported formatRun the imported format

The Repor t\L ines\RecordRepor t\L ines\Record element is bound to the model.Data.L istmodel.Data.L ist list to generate a single line for

every record from the bound list.

The Prefix2Prefix2  element generates P2P2  symbols to indicate that the line that is added is for the tax

transaction details.

The TaxAmountTaxAmount element is bound to model.Data.L ist.Valuemodel.Data.L ist.Value (which is shown as @.Value@.Value in the

relative path view) to generate the tax value of the current tax transaction.

The RunningTotalRunningTotal  element is a placeholder for the running total of the tax values. Currently, this

element has no output, because neither a binding nor a default value is configured for it.

The ExecutionDateTimeExecutionDateTime element generates the date and time (including milliseconds) when the

current transaction is processed in this report.

The Repor t\L ines\Summar yRepor t\L ines\Summar y  element doesn't have to be bound to a data source to generate a single

line in an outbound document.

The Prefix3Prefix3  element generates P3P3  symbols to indicate that the line that is added contains the total tax

value.

The TotalTaxAmountTotalTaxAmount element is bound to model.Data.Summar y.Totalmodel.Data.Summar y.Total  to generate the sum of the

tax values of the processed tax transactions.

The ExecutionDateTimeExecutionDateTime element generates the date and time (including milliseconds) when the

summary line is added.

1. On the Format designerFormat designer  page, select RunRun.

2. Download the file that the web browser offers, and open it for review.



Modify the format so that the summing is based on generated outputModify the format so that the summing is based on generated output

Notice that summary line 22 presents the sum of the tax values for the processed transactions. Because the

format is configured to use the model.Data.Summar y.Totalmodel.Data.Summar y.Total  binding to return this sum, the sum is calculated

by calling the TotalSumTotalSum aggregation of the GroupedGrouped data source of the GroupBy type that uses the model

mapping. To calculate this aggregation, model mapping iterates over all transactions that have been selected in

the FilteredFiltered data source. By comparing the execution times of lines 21 and 22, you can determine that

calculation of the sum took 10 milliseconds (ms). By comparing the execution times of lines 2 and 21, you can

determine that generation of all transactional lines took 7 ms. Therefore, a total of 17 ms was required.

If the volume of transactions is much larger than the volume in the current example, the summing time might

increase and cause performance issues. By changing the setting of the format, you can help prevent these

performance issues. Because you access tax values to include them in the generated report, you can reuse this

information to sum tax values. For more information, see Configure format to do counting and summing.

1. On the Format designerFormat designer  page, on the FormatFormat tab, select the Repor tRepor t file element in the format tree.

2. Set the Collect output detailsCollect output details  option to YesYes . You can now configure this format by using the content of

an existing report as a data source that can be accessed by using the built-in ER functions in the Data

collection category.

3. On the MappingMapping tab, select the Repor t\L inesRepor t\L ines  sequence element.

4. Configure the Collected data key nameCollected data key name expression as WsColumn .

5. Configure the Collected data key valueCollected data key value expression as WsRow .



6. Select the Repor t\L ines\Record\TaxAmountRepor t\L ines\Record\TaxAmount numeric element.

7. Configure the Collected data key nameCollected data key name expression as SummingAmountKey .

You can consider this setting the fulfillment of a virtual worksheet, where the value of cell A1 is appended

with the value of the tax amount from every processed tax transaction.

8. Select the Repor t\L ines\Record\RunningTotalRepor t\L ines\Record\RunningTotal  numeric element, and then select Edit formulaEdit formula.

9. Configure the SUMIF(SummingAmountKey, WsColumn, WsRow)  expression by using the built-in SUMIF ER

function.

10. Select SaveSave.



11. Close the Formula designerFormula designer  page.

12. Select SaveSave, and then select RunRun.

13. Download and review the file that the web browser offers.

Line 21 contains the running total of tax values that is calculated for all processed transactions by using

the generated output as a data source. This data source starts from the beginning of the report and

continues through the last tax transaction. Line 22 contains the sum of the tax values for all processed

transactions that are calculated in the model mapping by using the data source of the GroupBy type.

Notice that these values are equal. Therefore, the output-based summing can be used instead of

GroupByGroupBy . By comparing the execution times of lines 2 and 21, you can determine that generation of all

the transactional lines and summing took 9 ms. Therefore, as far as the generation of detailed lines and

the summing of tax values are concerned, the modified format is approximately two times faster than the

original format.

14. Select the Repor t\L ines\Summar y\TotalTaxAmountRepor t\L ines\Summar y\TotalTaxAmount numeric element, and then select Edit formulaEdit formula.

15. Enter the SUMIF(SummingAmountKey, WsColumn, WsRow)  expression instead of the existing expression.



Put values of output-based summing in the report headerPut values of output-based summing in the report header

16. Select SaveSave, and then select RunRun.

17. Download and review the file that the web browser offers.

Notice that the running total of tax values on the last transaction details line now equals the sum on the

summary line.

If, for example, you must present the sum of tax values in the header of your report, you can modify your

format.

1. On the Format designerFormat designer  page, on the FormatFormat tab, select the Repor t\L ines\Summar yRepor t\L ines\Summar y  sequence

element.

2. Select Move upMove up.

3. Select SaveSave, and then select RunRun.

4. Download and review the file that the web browser offers.



Defer the execution of the summary sequence so that the calculated total is usedDefer the execution of the summary sequence so that the calculated total is used

Notice that the sum of tax values on summary line 2 now equals 0 (zero), because this sum is now

calculated based on the generated output. When line 2 is generated, the generated output doesn't yet

contain lines that have transaction details. You can configure this format to defer the execution of the

Repor t\L ines\Summar yRepor t\L ines\Summar y  sequence element until the Repor t\L ines\RecordRepor t\L ines\Record sequence element has

been run for all tax transactions.

1. On the Format designerFormat designer  page, on the FormatFormat tab, select the Repor t\L ines\Summar yRepor t\L ines\Summar y  sequence

element.

2. Set the Deferred executionDeferred execution option to YesYes .

3. Select SaveSave, and then select RunRun.

4. Download and review the file that the web browser offers.

The Repor t\L ines\Summar yRepor t\L ines\Summar y  sequence element is now run only after all other items that are nested

under its parent element, Repor t\L inesRepor t\L ines , have been run. Therefore, it's run after the

Repor t\L ines\RecordRepor t\L ines\Record sequence element has been run for all tax transactions of the model.Data.L istmodel.Data.L ist

data source. The execution times of lines 1, 2, and 3, and of the last line, 22, reveal this fact.
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C O N T EN T  DESC RIP T IO NC O N T EN T  DESC RIP T IO N F IL E  N A M EF IL E  N A M E

ER data model configuration Model to learn deferred elements.version.1.xml

You can use the Operations designer of the Electronic reporting (ER) framework to configure the format

component of an ER solution that is used to generate outbound documents in XML format. The hierarchical

structure of the configured format component consists of format elements of various types. These format

elements are used to fill generated documents with the required information at runtime. By default, when you

run an ER format, the format elements are run in the same order as they are presented in the format hierarchy:

one by one, from top to bottom. However, at design time, you can change the execution order for any XML

elements of the configured format component.

 By turning on the Deferred executionDeferred execution option for an XML element in the configured format, you can defer

(postpone) the execution of that element. In this case, the element isn't run until all other elements of its parent

have been run.

To learn more about this feature, complete the example in this topic.

The Deferred executionDeferred execution option is supported only for XML elements that are configured for an ER format that

is used to generate outboundoutbound documents in XML format.

The Deferred executionDeferred execution option is supported only for XML elements that reside in only one other XML element.

Therefore, it isn't applicable to XML elements that reside in other types of format elements (for example, in an

XML sequenceXML sequence element).

The Deferred executionDeferred execution option isn't supported for XML elements that reside in the Common\FileCommon\File format

element when the Split fileSplit file option is set to YesYes . For more information about how to split XML files, see Split

generated XML files based on file size and content quantity.

The following steps explain how a user in the System administrator or Electronic reporting functional consultant

role can configure an ER format that contains an XML element where the order of execution differs from the

order in the format hierarchy.

These steps can be performed in the USMFUSMF company in Microsoft Dynamics 365 Finance.

To complete this example, you must have access to the USMFUSMF company in Finance for one of the following roles:

Electronic reporting functional consultant

System administrator

If you haven't yet completed the example in the Defer the execution of sequence elements in ER formats topic,

download the following configurations of the sample ER solution.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-defer-xml-element.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/sysadmin/tasks/assign-users-security-roles
https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg


ER model mapping configuration Mapping to learn deferred elements.version.1.1.xml
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C O N T EN T  DESC RIP T IO NC O N T EN T  DESC RIP T IO N F IL E  N A M EF IL E  N A M E

ER format configuration Format to learn deferred XML elements.version.1.1.xml

Import the sample ER configurationsImport the sample ER configurations

Activate a configuration providerActivate a configuration provider

Before you begin, you must also download and save the following configuration of the sample ER solution to

your local computer.

1. Go to Organization administrationOrganization administration > WorkspacesWorkspaces  > Electronic repor tingElectronic repor ting.

2. Select Repor ting configurationsRepor ting configurations .

3. On the ConfigurationsConfigurations  page, if the Model to learn deferred elementsModel to learn deferred elements  configuration isn't available in

the configuration tree, import the ER data model configuration:

a. Select ExchangeExchange, and then select Load from XML fileLoad from XML file.

b. Select BrowseBrowse, find and select the Model to learn deferred elements.1 .xmlModel to learn deferred elements.1 .xml  file, and then select

OKOK.

4. If the Mapping to learn deferred elementsMapping to learn deferred elements  configuration isn't available in the configuration tree,

import the ER model mapping configuration:

a. Select ExchangeExchange, and then select Load from XML fileLoad from XML file.

b. Select BrowseBrowse, find and select the Mapping to learn deferred elements.1 .1 .xmlMapping to learn deferred elements.1 .1 .xml  file, and then

select OKOK.

5. Import the ER format configuration:

a. Select ExchangeExchange, and then select Load from XML fileLoad from XML file.

b. Select BrowseBrowse, find and select the Format to learn deferred XML elements.1 .1 .xmlFormat to learn deferred XML elements.1 .1 .xml  file, and then

select OKOK.

6. In the configuration tree, expand Model to learn deferred elementsModel to learn deferred elements .

7. Review the list of imported ER configurations in the configuration tree.

1. Go to Organization administrationOrganization administration > WorkspacesWorkspaces  > Electronic repor tingElectronic repor ting.

2. On the Localization configurationsLocalization configurations  page, in the Configuration providersConfiguration providers  section, make sure that

https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg
https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg


Review the imported model mappingReview the imported model mapping

the configuration provider for the Litware, Inc. ( http://www.litware.com ) sample company is listed, and

that it's marked as active. If this configuration provider isn't listed, or if it isn't marked as active, follow the

steps in the Create a configuration provider and mark it as active topic.

Review the settings of the ER model mapping component that is configured to access tax transactions and

expose accessed data on request.

1. Go to Organization administrationOrganization administration > WorkspacesWorkspaces  > Electronic repor tingElectronic repor ting.

2. Select Repor ting configurationsRepor ting configurations .

3. On the ConfigurationsConfigurations  page, in the configuration tree, expand Model to learn deferred elementsModel to learn deferred elements .

4. Select the Mapping to learn deferred elementsMapping to learn deferred elements  configuration.

5. Select DesignerDesigner  to open the list of mappings.

6. Select DesignerDesigner  to review the mapping details.

7. Select Show detailsShow details .

8. Review the data sources that are configured to access tax transactions:

The TransactionsTransactions  data source of the Table record type is configured to access records of the

TaxTransTaxTrans  application table.

The VouchersVouchers  data source of the Calculated field type is configured to return the required voucher

codes (INV-10000349INV-10000349  and INV-10000350INV-10000350 ) as a list of records.

The FilteredFiltered data source of the Calculated field type is configured to select, from the

TransactionsTransactions  data source, only tax transactions of the required vouchers.

The $TaxAmount$TaxAmount field of the Calculated field type is added for the FilteredFiltered data source to expose

the tax value that has the opposite sign.

The GroupedGrouped data source of the Group By type is configured to group filtered tax transactions of

the FilteredFiltered data source.

The TotalSumTotalSum aggregation field of the GroupedGrouped data source is configured to summarize values

of the $TaxAmount$TaxAmount field of the FilteredFiltered data source for all filtered tax transactions of that data

source.



Review the imported formatReview the imported format

9. Review how the configured data sources are bound to the data model, and how they expose accessed

data to make it available in an ER format:

The FilteredFiltered data source is bound to the Data.L istData.L ist field of the data model.

The $TaxAmount$TaxAmount field of the FilteredFiltered data source is bound to the Data.L ist.ValueData.L ist.Value field of the data

model.

The TotalSumTotalSum field of the GroupedGrouped data source is bound to the Data.Summar y.TotalData.Summar y.Total  field of the

data model.

10. Close the Model mapping designerModel mapping designer  and Model mappingsModel mappings  pages.

1. On the ConfigurationsConfigurations  page, in the configuration tree, select the Format to learn deferred XMLFormat to learn deferred XML

elementselements  configuration.

2. Select DesignerDesigner  to review the format details.

3. Select Show detailsShow details .

4. Review the settings of the ER format components that are configured to generate an outbound document

in XML format that includes details of the tax transactions:

The Repor t\MessageRepor t\Message XML element is configured to fill the outbound document with a single node

that includes the nested XML elements (HeaderHeader , RecordRecord, and Summar ySummar y ).

The Repor t\Message\HeaderRepor t\Message\Header  XML element is configured to fill the outbound document with a



single header node that shows the date and time when the processing starts.

The Repor t \Message\RecordRepor t \Message\Record XML element is configured to fill the outbound document with a

single record node that shows the details of a single tax transaction.

The Repor t\Message\Summar yRepor t\Message\Summar y  XML element is configured to fill the outbound document with a

single summary node that includes the sum of the tax values from the processed tax transactions.

5. On the MappingMapping tab, review the following details:

The Repor t\Message\HeaderRepor t\Message\Header  element doesn't have to be bound to a source to generate a single

node in an outbound document.

The ExecutionDateTimeExecutionDateTime attribute generates the date and time (including milliseconds) when the

header node is added.

The Repor t\Message\RecordRepor t\Message\Record element is bound to the model.Data.L istmodel.Data.L ist list to generate a single

record node for every record from the bound list.

The TaxAmountTaxAmount attribute is bound to model.Data.L ist.Valuemodel.Data.L ist.Value (which is shown as @.Value@.Value in the

relative path view) to generate the tax value of the current tax transaction.

The RunningTotalRunningTotal  attribute is a placeholder for the running total of the tax values. Currently, this

attribute has no output, because neither a binding nor a default value is configured for it.

The ExecutionDateTimeExecutionDateTime attribute generates the date and time (including milliseconds) when the

current transaction is processed in this report.

The Repor t\Message\Summar yRepor t\Message\Summar y  element doesn't have to be bound to a data source to generate a

single node in an outbound document.

The TotalTaxAmountTotalTaxAmount attribute is bound to model.Data.Summar y.Totalmodel.Data.Summar y.Total  to generate the sum of the

tax values of the processed tax transactions.

The ExecutionDateTimeExecutionDateTime attribute generates the date and time (including milliseconds) when the

summary node is added.



Run the imported formatRun the imported format

Modify the format so that the calculation is based on generated outputModify the format so that the calculation is based on generated output

1. On the Format designerFormat designer  page, select RunRun.

2. Download the file that the web browser offers, and open it for review.

Notice that the summary node presents the sum of the tax values for the processed transactions. Because the

format is configured to use the model.Data.Summar y.Totalmodel.Data.Summar y.Total  binding to return this sum, the sum is calculated

by calling the TotalSumTotalSum aggregation of the GroupedGrouped data source of the GroupBy type in the model mapping.

To calculate this aggregation, the model mapping iterates over all transactions that have been selected in the

FilteredFiltered data source. By comparing the execution times of the summary node and the last record node, you can

determine that calculation of the sum took 12 milliseconds (ms). By comparing the execution times of the first

and last record nodes, you can determine that generation of all record nodes took 9 ms. Therefore, a total of 21

ms was required.

If the volume of transaction is much larger than the volume in the current example, the calculation time might

increase and cause performance issues. By changing the setting of the format, you can help prevent these

performance issues. Because you access tax values to include them in the generated report, you can reuse this

information to calculate tax values. For more information, see Configure format to do counting and summing.

1. On the Format designerFormat designer  page, on the FormatFormat tab, select the Repor tRepor t file element in the format tree.



2. Set the Collect output detailsCollect output details  option to YesYes . You can now configure this format by using the content of

a generated report as a data source that can be accessed by using the built-in ER functions in the Data

collection category.

3. On the MappingMapping tab, select the Repor t\Message\RecordRepor t\Message\Record XML element.

4. Configure the Collected data key nameCollected data key name expression as WsColumn .

5. Configure the Collected data key valueCollected data key value expression as WsRow .

6. Select the Repor t\Message\Record\TaxAmountRepor t\Message\Record\TaxAmount attribute.

7. Configure the Collected data key nameCollected data key name expression as SummingAmountKey .

You can consider this setting the fulfillment of a virtual worksheet, where the value of cell A1 is appended

with the value of the tax amount from every processed tax transaction.

8. Select the Repor t\Message\Record\RunningTotalRepor t\Message\Record\RunningTotal  attribute, and then select Edit formulaEdit formula.

9. Configure the SUMIF(SummingAmountKey, WsColumn, WsRow)  expression by using the built-in SUMIF ER

function, and then select SaveSave.



10. Close the Formula designerFormula designer  page.

11. Select SaveSave, and then select RunRun.

12. Download and review the file that the web browser offers.

The last record node contains the running total of tax values that is calculated for all processed

transactions by using the generated output as a data source. This data source starts from the beginning

of the report and continues through the last tax transaction. The summary node contains the sum of the

tax values for all processed transactions that are calculated in the model mapping by using the data

source of the GroupBy type. Notice that these values are equal. Therefore, the output-based summing can

be used instead of GroupByGroupBy . By comparing the execution times of the first record node and the

summary node, you can determine that generation of all the record nodes and summing took 11 ms.

Therefore, as far as the generation of record nodes and the summing of tax values are concerned, the

modified format is approximately two times faster than the original format.

13. Select the Repor t\Message\Summar y\TotalTaxAmountRepor t\Message\Summar y\TotalTaxAmount attribute, and then select Edit formulaEdit formula.

14. Enter the SUMIF(SummingAmountKey, WsColumn, WsRow)  expression instead of the existing expression.

15. Select SaveSave, and then select RunRun.

16. Download and review the file that the web browser offers.



Put values of output-based summing in the report headerPut values of output-based summing in the report header

Defer the execution of the summary XML element so that the calculated total is usedDefer the execution of the summary XML element so that the calculated total is used

Notice that the running total of tax values in the last record node now equals the sum in the summary

node.

If, for example, you must present the sum of tax values in the header of your report, you can modify your

format.

1. On the Format designerFormat designer  page, on the FormatFormat tab, select the Repor t\Message\Summar yRepor t\Message\Summar y  XML

element.

2. Select Move upMove up.

3. Select SaveSave, and then select RunRun.

4. Download and review the file that the web browser offers.

Notice that the sum of tax values in the summary node now equals 0 (zero), because this sum is now

calculated based on the generated output. When the first record node is generated, the generated output

doesn't yet contain record nodes that have transaction details. You can configure this format to defer the

execution of the Repor t\Message\Summar yRepor t\Message\Summar y  element until the Repor t\Message\RecordRepor t\Message\Record element has

been run for all tax transactions.



Additional resources

1. On the Format designerFormat designer  page, on the FormatFormat tab, select the Repor t\Message\Summar yRepor t\Message\Summar y  XML

element.

2. Set the Deferred executionDeferred execution option to YesYes .

3. Select SaveSave, and then select RunRun.

4. Download and review the file that the web browser offers.

The Repor t\Message\Summar yRepor t\Message\Summar y  element is now run only after all other items that are nested under its

parent element, Repor t\MessageRepor t\Message, have been run. Therefore, it's run after the

Repor t\Message\RecordRepor t\Message\Record element has been run for all tax transactions of the model.Data.L istmodel.Data.L ist data

source. The execution times of the first and last record nodes, and of the header and summary nodes,

reveal this fact.

Configure format to do counting and summing

Trace execution of ER format to troubleshoot performance issues

Defer the execution of sequence elements in ER formats
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Prerequisites for ER setup

AT T RIB UT E N A M EAT T RIB UT E N A M E AT T RIB UT E VA L UEAT T RIB UT E VA L UE

Class Attach fileAttach file

Group FileFile

Location Azure storageAzure storage or SharePointSharePoint

Set up ER

Main parameters

This topic explains how to set up the basic functionality for Electronic reporting (ER). It also describes the steps

that you must complete before you can set up ER.

Before you can set up ER, you must set up the required document types in Document management:

A document type for Microsoft Office documents that are used as templates for ER reports.

A document type that is used to store the output of ER reports in the jobs archive.

A document type that is used to store the output of ER reports so that they can be viewed in other programs.

A document type that is used to keep baselines of outputs of ER configurations.

A document type that is used to handle files in the ER framework for all other purposes.

For each document type, the following attribute values can be selected.

Use the following procedure to set up the basic functionality of ER for all legal entities.

1. Open the Electronic repor tingElectronic repor ting workspace page.

2. Click Electronic repor ting parametersElectronic repor ting parameters .

On the GeneralGeneral  tab of the Electronic repor ting parametersElectronic repor ting parameters  page, set the following ER parameters:

Enable design modeEnable design mode

Set this option to YesYes  to enable embedded ER designers, so that users can create their own ER

configurations.

Set this option to NoNo to require that users access the functionality of ER designers by signing up for

Configuration service.

Disable tracing of ER performance in data handlingDisable tracing of ER performance in data handling

Set this option to NoNo to allow Microsoft Telemetry to collect information about the average time that

is required to process a single incoming or outgoing record as an ER configuration. This information is

tracked as a specific health metric of the environment, and it will help Microsoft quickly identify and

address issues that affect customers who use the ER framework.

Set this option to YesYes  to stop collecting telemetry information.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/electronic-reporting-er-configure-parameters.md
https://docs.microsoft.com/en-us/business-applications-release-notes/october18/dynamics365-finance-operations/regulatory-service-configuration


      Parameters to manage documentsOn the AttachmentsAttachments  tab of the Electronic repor ting parametersElectronic repor ting parameters  page, set the following ER parameters:

ConfigurationsConfigurations  – Select a document type to specify the storage of templates of ER formats. This

document type is selected within the scope of a specific company. This document type will be used,

regardless of the company that a user is signed in to while an ER format is being used.

Job archiveJob archive – Select a document type to specify the storage of generated documents that are attached

to the records of the ER jobs archive. This document type is selected as a company-specific document

type. You must make sure that the selected document type is configured for every company that you plan

to run ER formats for, and then store the results in the ER jobs archive.

Temporar yTemporar y  – Select a document type to specify the storage of generated documents that are used for

other purposes. For example, documents might be generated for preview by other services. This

document type is selected as a company-specific document type. You must make sure that the selected

document type is configured for every company that you plan to run ER formats for, and then store the

results in the ER jobs archive.

BaselineBaseline – Select a document type to specify the storage of documents that are used as baselines during

the automated testing of ER configurations. This document type is selected as a company-specific

document type. You must make sure that the selected document type is configured for every company

that you plan to run ER formats for, and then store the results in the ER jobs archive.

OthersOthers  – Select a document type to specify the storage of generated documents that are used for all

other purposes. This document type is selected as a company-specific document type. You must make

sure that the selected document type is configured for every company that you plan to run ER formats

for, and then store the results in the ER jobs archive.

Stop making backup copies of templatesStop making backup copies of templates

Set this option to NoNo to automatically create a backup copy of any ER format configuration template

and store the copy in the database storage.

Set this option to YesYes  to stop making backup copies of ER formation configuration templates.

For more information, see Backup storage of ER templates.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er-configure-parameters-main.png


LCS parameters

RCS parameters

On the LCSLCS  tab of the Electronic repor ting parametersElectronic repor ting parameters  page, define the number of parallel threads that

should be used to load an ER configuration from repositories in Microsoft Dynamics Lifecycle Services (LCS), so

that the configurations are loaded in the most efficient manner. The value can vary from 11  through 1515 ,

depending on the available resources of the current program. Based on this setting and the number of other

tasks and their priorities, the real number of threads will be defined automatically.

On the RCSRCS  tab of the Electronic repor ting parametersElectronic repor ting parameters  page, sign up for Configuration service.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er-configure-parameters-documents.png
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Active ER configurations provider

Optional setup for ER

Frequently asked questions

On the Configuration provider tableConfiguration provider table page, create ER provider records. Each provider can be marked as

ActiveActive. The active provider's name and internet address are stored in an ER configuration, as attributes of the

configuration owner.

In addition to the basic functionality, ER has other functionality that you can set up.

On the Electronic repor ting destinationElectronic repor ting destination page, define the ER output destinations for each file output of

each ER format configuration. Use the document types of the Document management framework that you

set up earlier. You can also use this page to set up the optional ER functionality for each legal entity. For more

information, see Electronic reporting (ER) destinations.

When you add new Application Object Tree (AOT) artifacts or update existing AOT artifacts that are used as

data sources (tables, views, or data entities) in ER, use the Rebuild table referencesRebuild table references  menu item

(Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > Rebuild table referencesRebuild table references ) to bring your AOT

changes into the ER metadata.

Question:Question: What is the optimal number of parallel threads to use to load an ER configuration from LCS?

Answer :Answer : To calculate the optimal number of parallel threads, use the following empirical formula: Cores ÷ 2 +

1(2). For example, if the program runs on a virtual machine (VM) that has two CPUs, and each CPU contains four

cores, the optimal number is five or six parallel threads.

Question:Question: I have added a custom table to the AOT. I created a new ER model mapping configuration for my ER

data model. During the design of the model mapping, I tried to add a new data source type, Table recordsTable records , that

refers to my table. I could manually add my table name to the TableTable lookup, and the ER model mapping

accepted it without errors or warnings. However, my table's name isn't included in the list of available choices

that the TableTable lookup of this data source offers. How do I include the name of my table?

Answer :Answer : To include the name of your custom table in the TableTable lookup, use the Rebuild table referencesRebuild table references

menu item as described in the "Optional setup for ER" section earlier in this topic.

Question:Question: Why can't I mark the Microsoft provider as ActiveActive in the Electronic repor tingElectronic repor ting workspace in my

production environment?

Answer :Answer : The Microsoft provider is used to mark ER configurations that have been designed and maintained by

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er-configure-parameters-rcs.png


 Addit ional resources

NOTENOTE

Microsoft. We expect that Microsoft will release new versions of the configurations in the future. We

recommend that you not mark the Microsoft provider as ActiveActive. Otherwise, you can update the configurations.

(For example, you can change the content and register new versions.) These updates will cause issues in the

future, when Microsoft provides new versions of the configurations, and those new versions must be imported

and adopted. Instead, register a new ER provider for your company, and use it for your ER configurations

maintenance. To reuse a Microsoft configuration, select it as the base for your derived copy. To incorporate

changes that are provided by Microsoft, rebase your configuration to a new version of the Microsoft

configuration when it becomes available.

Question:Question: I successfully ran an ER format in one company. However, when I ran the same ER format in another

company and used the same settings, I received the following error message: "The provided document type is

not a File type." Why?

Answer :Answer : Most likely, the second company doesn't contain document types that have been selected in the JobJob

archivearchive, Temporar yTemporar y , BaselineBaseline, and OthersOthers  ER parameters. To fix this issue, configure these document types in

the second company.

Electronic reporting (ER) overview

Electronic reporting (ER) destinations

Configuration service of Regulatory Services

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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NOTENOTE

Automated recovery and notification

The Electronic reporting (ER) overview lets business users configure formats for outbound documents

according to the legal requirements of various countries and regions. Configured ER formats can use predefined

templates to generate outbound documents in various formats, such as Microsoft Excel workbooks, Microsoft

Word documents, or PDF documents. The templates are filled with data that the configured dataflow for

generated documents requires.

Each configured format can be published as part of an ER solution. Each ER solution can be exported from one

instance of Finance and Operations and imported into another instance.

The ER framework uses the Configure document management to keep the required templates for the current

Finance and Operations instance. Depending on the settings of the ER framework, Microsoft Azure Blob storage

or a Microsoft SharePoint folder can be selected as the physical primary storage location for templates. (For

more information, see Configure the Electronic reporting (ER) framework.) The DocuValue table holds an

individual record for each template. In each record, the AccessInformationAccessInformation field stores the path of a template

file that is located in the configured storage location.

When you manage your Finance and Operations instances, you might decide to migrate the current instance to

another location. For example, you might migrate your production instance to a new sandbox environment. If

you configured the ER framework to store templates in Blob storage, the DocuValue table in the new sandbox

environment refers to the instance of Blob storage in the production environment. However, this instance can't

be accessed from the sandbox environment, because the migration process doesn't support the migration of

artifacts in Blob storage. Therefore, if you try to run an ER format that uses a template to generate business

documents, an exception occurs, and you're notified about the missing template. You're also guided to use the ER

cleanup tool to delete and then re-import the ER format configuration that contains the template. Because you

might have several ER format configurations, this process can be time consuming.

The Backup storage of ER templates feature can help you make your templates so that they are always available

to generate business documents.

This feature can be used only when Blob storage has been selected as the physical storage location for ER templates.

For this feature, every template of a new ER format configuration in the current environment is automatically

saved to the backup storage location for templates (the ERDocuDatabaseStorage database table) when the

following events occur :

You import a new ER format configuration that contains a template.

You complete the draft version of an ER format configuration that contains a template.

Backup copies of templates are migrated to a new instance of Finance and Operations as part of the application

database.

If a template of an ER format is required for generation of outbound documents, to process vendor payments

including generation of payment advice and control reports, for example, but the required template isn't found

in the primary storage location, the following events occur :

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-backup-storage-templates.md


NOTENOTE

If the template is available in the backup storage location, it is automatically taken from the backup

storage location, restored to the primary storage location, and used for the current execution.

Every user who is assigned to the Electronic repor ting developerElectronic repor ting developer  or System administratorSystem administrator  role is

notified about the missing template issue through the Action center. The message that appears depends

on the value of the Automatically run the procedure of restor ing the broken templates in batchAutomatically run the procedure of restor ing the broken templates in batch

parameter :

If this parameter is set to OffOff , the message recommends that you start the batch process to

automatically fix similar issues for other ER format configuration templates. The message includes a

link that you can use to start the batch process.

If this parameter is set to OnOn, the message notifies you that a missing templates issue has been

discovered, and that a new batch process, Restore broken templates from internal databaseRestore broken templates from internal database

backupbackup, has been automatically scheduled. This batch process will automatically fix similar issues for

other templates.

To set up the Automatically run the procedure of restor ing the broken templates in batchAutomatically run the procedure of restor ing the broken templates in batch parameter,

complete the following steps:

1. In Finance and Operations, open the Organization administration > Electronic repor ting >Organization administration > Electronic repor ting >

Configurations pageConfigurations page.

2. On the ConfigurationsConfigurations  page, on the Action Pane, on the ConfigurationsConfigurations  tab, in the Advanced settingsAdvanced settings

group, select User parametersUser parameters .

3. In the User parametersUser parameters  dialog box, set the required value for the Automatically run the procedure ofAutomatically run the procedure of

restor ing the broken templates in batchrestor ing the broken templates in batch parameter.

This parameter is defined as application user and logged company specific.

The following illustration shows an example of the message that appears when the Automatically run theAutomatically run the

procedure of restor ing the broken templates in batchprocedure of restor ing the broken templates in batch parameter is set to OnOn.



The following illustration shows the Restore broken templates from internal database backupRestore broken templates from internal database backup batch

process on the Batch jobBatch job page.

The execution log of the completed Restore broken templates from internal database backupRestore broken templates from internal database backup batch

process includes information about the templates that have been restored from the backup storage location to

the primary storage location.

By default, the process of automatically creating backup copies of templates that reside in ER format

configurations is turned on. To stop making backup copies of templates, set the Stop making backup copiesStop making backup copies

of templateof template option to YesYes  on the AttachmentsAttachments  tab of the Electronic repor ting parametersElectronic repor ting parameters  page. You can

open this page from the Electronic repor tingElectronic repor ting workspace.

If you set the Stop making backup copies of templatesStop making backup copies of templates  option to YesYes  and don't want to keep the backup

copies that were previously made of templates, select Clean up backup storageClean up backup storage on the Electronic repor tingElectronic repor ting

parametersparameters  page.

If you upgraded your environment to Finance and Operations version 10.0.5 (October 2019) and want to

migrate to a new environment that includes ER format configurations that can be run, select Fill in backupFill in backup

storagestorage on the Electronic repor ting parametersElectronic repor ting parameters  page before the migration occurs. This button starts the

process of making backup copies of all available templates, so that they can be stored in the ER backup storage

location for templates.



Manual recovery

Supported deployments

Additional resources

NOTENOTE

Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > Restore broken templatesRestore broken templates  to manually

initiate the process of restoring ER templates from the backup storage location to the primary storage location.

Before you start this process, on the Restore broken templatesRestore broken templates  page you can specify whether it will be

performed interactively, or the batch process will be scheduled for this.

In Finance and Operations version 10.0.5, the Backup storage of ER templates feature is available only in cloud

deployments.

Electronic reporting (ER) overview

Configure the Electronic reporting (ER) framework
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Create a provider

Select as an active provider

This topic explains how a user assigned to the System Administrator or Electronic Reporting Developer role can

create a configuration provider for Electronic reporting (ER). Each ER configuration will refer to the provider as

the author of the configuration. In this example, you will create a configuration provider for sample company,

Litware, Inc. These steps can be performed in any company as ER configuration providers are shared among all

companies.

1. Go to the navigation panenavigation pane in the upper left corner and select Organization administrationOrganization administration.

2. Go to Workspaces > Electronic repor tingWorkspaces > Electronic repor ting.

3. Go to Related links > Configuration providersRelated links > Configuration providers .

4. Select NewNew .

5. In the Name field, type Litware, Inc. .

6. In the Internet address field, type https://www.litware.com .

7. Select SaveSave.

8. Close the page.

A provider record has a unique name and URL. Review the content of this page and skip this

procedure if a record for Litware, Inc. (https://www.litware.com) already exists.

1. Select the Litware, Inc. provider.

2. Select Set activeSet active.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-configuration-provider-mark-it-active-2016-11.md
https://www.litware.com
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Availability and general prerequisites

Overview

Default behaviorDefault behavior

You can configure a destination for each Electronic reporting (ER) format configuration and its output

component (a folder or a file). Users who have appropriate access rights can also modify destination settings at

runtime. This topic explains ER destination management, the types of destinations that are supported, and

security considerations.

ER format configurations usually contain at least one output component: a file. Typically, configurations contain

multiple file output components of different types (for example, XML, TXT, XLSX, DOCX, or PDF) that are

grouped into either a single folder or multiple folders. ER destination management lets you preconfigure what

occurs when each component is run. By default, when a configuration is run, a dialog box appears that lets you

save or open the file. The same behavior also occurs when you import an ER configuration and don't configure

any specific destinations for it. After a destination is created for a main output component, that destination

overrides the default behavior, and the folder or file is sent according to the destination's settings.

The functionality for ER destinations isn't available in Microsoft Dynamics AX 7.0 (February 2016). Therefore,

you must install Microsoft Dynamics 365 for Operations version 1611 (November 2016) or later to use the

following destination types:

Email

Archive

File

Screen

Power BI

Alternatively, you can install one of the following prerequisites. However, be aware that these alternatives

provide a more limited ER destination experience.

Microsoft Dynamics AX application version 7.0.1 (May 2016)

Electronic reporting destination management application hotfix

There is also a Print destination type. To use it, you must install Microsoft Dynamics 365 Finance version 10.0.9

(April 2020).

You can set up destinations only for ER configurations that have been imported into the current Finance

instance, and for the formats that are available on the Electronic repor ting configurationsElectronic repor ting configurations  page. The

functionality for ER destination management is available at Organization administrationOrganization administration > ElectronicElectronic

repor tingrepor ting > Electronic repor ting destinationElectronic repor ting destination.

The default behavior for an ER format configuration depends on the execution type that you specify when an ER

format starts.

In the Intrastat Repor tIntrastat Repor t dialog box, on the Run in the backgroundRun in the background FastTab, if you set the Batch processingBatch processing

option to NoNo, an ER format is run immediately in interactive mode. When this execution is successfully

completed, a generated outbound document is made available for download.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/electronic-reporting-destinations.md
https://fix.lcs.dynamics.com/issue/results/?q=3160213


NOTENOTE

User-configured behaviorUser-configured behavior

If you set the Batch processingBatch processing option to YesYes , an ER format is run in batch mode. The appropriate batch job is

created, based on the parameters that you specify on the Run in the backgroundRun in the background tab of the ER parametersER parameters

dialog box.

The job description informs you about the run of an ER format mapping. It also contains the name of the ER component

that is run.

You can find information about this job in several places:

NOTENOTE

Go to CommonCommon > Inquir iesInquir ies  > Batch jobsBatch jobs  > My batch jobsMy batch jobs  to check the status of the scheduled job.

Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > Electronic repor ting jobsElectronic repor ting jobs  to check

the status of the scheduled job and the execution results of the completed job. When job execution is

successfully completed, select Show filesShow files  on the Electronic repor ting jobsElectronic repor ting jobs  page to get a generated

outbound document.

This document is stored as an attachment of the current job record and is controlled by the Document

management framework. The document type that is used to store ER artifacts of this type is configured in the ER

parameters.

On the Electronic repor ting jobsElectronic repor ting jobs  page, select Show filesShow files  to view the list of any errors and warnings

that were generated during job execution.

On the Electronic repor ting destinationElectronic repor ting destination page, you can override the default behavior for a configuration.

Imported configurations aren't shown on this page until you select NewNew  and then, in the ReferenceReference field, select

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/sysadmin/batch-processing-overview
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a configuration to create destination settings for.

After you create a reference, you can create a file destination for each FolderFolder  or FileFile output component of the

referenced ER format.

Next, in the Destination settingsDestination settings  dialog box, you can enable and disable individual destinations for the file

destination. The SettingsSettings  button is used to control all the destinations for a selected file destination. In the

Destination settingsDestination settings  dialog box, you can control each destination separately by setting the EnabledEnabled option

for it.

In versions of Finance before version 10.0.9before version 10.0.9 , you can create one file destinationone file destination for each output

component of the same format, such as a folder or a file that is selected in the File NameFile Name field. However, in

version 10.0.9 and laterversion 10.0.9 and later , you can create multiple file destinationsmultiple file destinations  for each output component of the same

format.

For example, you can use this capability to configure file destinations for a file component that is used to

generate an outbound document in Excel format. One destination (Archive) can be configured to store the

original Excel file in the ER jobs archive, and another destination (Email) can be configured to simultaneously

convert the Excel file to PDF format and send the PDF file by email.
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Destination types

Applicability

NOTENOTE

When you run an ER format, all destinations that were configured for components of the format are always run.

In addition, in Finance version 10.0.17 and laterversion 10.0.17 and later , the ER destinations functionality has been improved and

now lets you configure different sets of destinations for a single ER format. This configuration marks each set as

configured for a particular user action. The ER API has been extended so that an action can be provided that the

user performs by running an ER format. The action code that is provided is passed to ER destinations. You can

run different destinations of an ER format, depending on the action code that is provided. For more information,

see Configure action-dependent ER destinations.

The following destinations are currently supported for ER formats. You can disable or enable all types at the

same time. In this way, you can either do nothing or send the component to all configured destinations.

Email

Archive

File

Screen

Power BI

Print

You can set up destinations only for ER configurations that have been imported, and for the formats that are

available on the Electronic repor ting configurationsElectronic repor ting configurations  page.

Configured destinations are company-specific. If you plan to use an ER format in different companies of the current

Finance instance, you must configure destinations for that ER format for each of those companies.

When you configure file destinations for a selected format, you configure them for the whole format.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er_destinations-sampledestinations.png
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/er-apis-app10-0-17
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/er-action-dependent-destinations


At the same time, you might have multiple versions of the format that have been imported into the current

Finance instance. You can view them if you select the ConfigurationConfiguration link that is offered when you select the

ReferenceReference field.

By default, configured destinations are applied only when you run an ER format version that has a status of

either CompletedCompleted or SharedShared. However, you must sometimes use configured destinations when the draft

version of an ER format is run. For example, you modify a draft version of your format, and you want to use

configured destinations to test how generated output will be delivered. Follow these steps to apply destinations

for an ER format when the draft version is run.

1. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > ConfigurationsConfigurations .

2. On the ConfigurationsConfigurations  page, on the Action Pane, on the ConfigurationsConfigurations  tab, in the Advanced settingsAdvanced settings

group, select User parametersUser parameters .

3. Set the Use destinations for draft statusUse destinations for draft status  option to YesYes .

To use the draft version of an ER format, you must mark the ER format accordingly.

1. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > ConfigurationsConfigurations .
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Destination failure handling

2. On the ConfigurationsConfigurations  page, on the Action Pane, on the ConfigurationsConfigurations  tab, in the Advanced settingsAdvanced settings

group, select User parametersUser parameters .

3. Set the Run settingRun setting option to YesYes .

After you complete this setup, the Run draftRun draft option becomes available for ER formats that you modify. Set this

option to YesYes  to start to use the draft version of the format when the format is run.

Usually, an ER format is run within the scope of a specific business process. However, the delivery of an

outbound document that is generated during execution of an ER format must sometimes be considered part of

that business process. In this case, if delivery of a generated outbound document to a configured destination is

unsuccessful, execution of the business process must be canceled. To configure the appropriate ER destination,

select the Stop processing on failureStop processing on failure option.

For example, you configure vendor payment processing so that the ISO20022 Credit TransferISO20022 Credit Transfer  ER format is

run to generate the payment file and supplementary documents (for example, the covering letter and control

report). If a payment should be considered successfully processed only if the covering letter is successfully

delivered by email, you must select the Stop processing on failureStop processing on failure check box for the CoveringLetterCoveringLetter

component in the appropriate file destination, as shown in the following illustration. In this case, the status of

the payment that is selected for processing will be changed from NoneNone to SentSent only when the covering letter

that is generated is successfully accepted for delivery by an email provider that is configured in the Finance

instance.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er_destinations-usersetting2.png
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Make PDF conversion availableMake PDF conversion available

ApplicabilityApplicability

LimitationsLimitations

If you clear the Stop processing on failureStop processing on failure check box for the CoveringLetterCoveringLetter  component in the destination,

a payment will be considered successfully processed even if the covering letter isn't successfully delivered by

email. The status of the payment will be changed from NoneNone to SentSent even if the covering letter can't be sent

because, for example, the email address of the recipient or sender is missing or incorrect.

You can use the PDF conversion option to convert output in Microsoft Office (Excel or Word) format to PDF

format.

To make the PDF conversion option available in the current Finance instance, open the Feature managementFeature management

workspace, and turn on the Conver t Electronic Repor ting outbound documents from Microsoft OfficeConver t Electronic Repor ting outbound documents from Microsoft Office

formats to PDFformats to PDF feature.

The PDF conversion option can be turned on only for file components that are used to generate output in Office

(Excel or Word) format (Excel fileExcel file). When this option is turned on, output that is generated in Office format is

automatically converted to PDF format.

The PDF conversion option is available only for cloud deployments.

The PDF document that is produced is limited to a maximum length of 300 pages.

In Finance version 10.0.9version 10.0.9 , only landscape page orientation is supported in the PDF document that is produced

from Excel output. In Finance version 10.0.10 (May 2020) and laterversion 10.0.10 (May 2020) and later , you can specify the page orientation of

the PDF document that is produced from Excel output while you configure an ER destination.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er_destinations-stopprocessingatdestinationfailure.png
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Use the PDF conversion optionUse the PDF conversion option
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Security considerations

Only the common system fonts of the Window operating system are used to convert output that contains no

embedded fonts.

To turn on PDF conversion for a file destination, select the Conver t to PDFConver t to PDF check box.

If you generate an ER configuration in Excel format and want to convert it to PDF format, you can specify the

page orientation of the PDF document. When you select the Conver t to PDFConver t to PDF check box to turn on PDF

conversion for a file destination that produces an output file in Excel format, the Page or ientationPage or ientation field

becomes available on the PDF conversion settingsPDF conversion settings  FastTab. In the Page or ientationPage or ientation field, select the

preferred orientation.

To have the option to select the PDF page orientation, you must install Finance version 10.0.10 or later.

The selected page orientation is applied to all ER configurations that are generated in Excel format and then converted to

PDF format.

If an ER configuration in Word format is converted to PDF format, the page orientation of the PDF document is taken

from the Word document.

Two types of privileges and duties are used for ER destinations. One type controls a user's overall ability to

maintain the destinations that are configured for a legal entity (that is, it controls access to the ElectronicElectronic

repor ting destinationsrepor ting destinations  page). The other type controls an application user's ability to override, at runtime, the

destination settings that an ER developer or ER functional consultant has configured.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er_destinations-turnonpdfconversion.png
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Frequently asked questions
I have imported electronic configurations, and I see them on the Electronic reporting configurations page.I have imported electronic configurations, and I see them on the Electronic reporting configurations page.
But why don't I see them on the Electronic reporting destinations page?But why don't I see them on the Electronic reporting destinations page?

Is there any way to define which Microsoft Azure Storage account and Azure Blob storage are used?Is there any way to define which Microsoft Azure Storage account and Azure Blob storage are used?

What is the purpose of the File destination in the destination settings? What does that setting do?What is the purpose of the File destination in the destination settings? What does that setting do?

Can you give an example of the formula that refers to a vendor account that I can send email to?Can you give an example of the formula that refers to a vendor account that I can send email to?

One of my format configurations contains multiple files that are grouped into one folder (for example,One of my format configurations contains multiple files that are grouped into one folder (for example,
Folder1 contains File1, File2, and File3). How do I set up destinations so that Folder1.zip isn't created at all,Folder1 contains File1, File2, and File3). How do I set up destinations so that Folder1.zip isn't created at all,
File1 is sent by email, File2 is sent to SharePoint, and I can open File3 immediately after the configuration isFile1 is sent by email, File2 is sent to SharePoint, and I can open File3 immediately after the configuration is
run?run?

Two privileges are used in the preceding duties. These privileges have the same names as the corresponding duties:

ERFormatDestinationConfigureERFormatDestinationConfigure and ERFormatDestinationRuntimeConfigureERFormatDestinationRuntimeConfigure.

Make sure that you select NewNew  and then select a configuration in the ReferenceReference field. The ElectronicElectronic

repor ting destinationsrepor ting destinations  page shows only configurations that destinations have been configured for.

No. The default Microsoft Azure Blob storage that is defined and used for the document management system is

used.

The FileFile destination is used to control a dialog box of your web browser when you run an ER format in

interactive mode. If you enable this destination, or if no destination is defined for a configuration, an open or

save dialog box appears in your web browser after an output file is created.

The formula is specific to the ER configuration. For example, if you use the ISO 20022 Credit Transfer

configuration, you can use '$PaymentsForCoveringLetter ' .Creditor.Identification.SourceID'$PaymentsForCoveringLetter ' .Creditor.Identification.SourceID or

model.Payments.Creditor.Identification.SourceIDmodel.Payments.Creditor.Identification.SourceID to get an associated vendor account.

Your format must first be available in the ER configurations. If this prerequisite is met, open the ElectronicElectronic

repor ting destinationrepor ting destination page, and create a new reference to the configuration. You must then have four file

destinations, one for each output component. Create the first file destination, give it a name such as FolderFolder , and

select a file name that represents a folder in your configuration. Then select SettingsSettings , and make sure that all the

destinations are disabled. For this file destination, the folder won't be created. By default, because of hierarchical

dependencies between files and parent folders, the files will behave in the same way. In other words, they won't
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be sent anywhere. To override that default behavior, you must create three more file destinations, one for each

file. In the destination settings for each, you must enable the destination that the file should be sent to.

Electronic reporting (ER) overview

Configure action-dependent ER destinations

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/er-action-dependent-destinations
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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SharePoint

You can configure an archive destination for each FolderFolder  or FileFile component of an Electronic reporting (ER)

format that is configured to generate outbound documents. Based on the destination setting, a generated

document is stored as an attachment of a record of the ER jobs list. To view the results, go to OrganizationOrganization

administrationadministration > Electronic repor tingElectronic repor ting > Electronic repor ting jobsElectronic repor ting jobs .

You can use this option to send the generated document to a Microsoft SharePoint folder or Microsoft Azure

Storage. Set EnabledEnabled to YesYes  to send output to a destination that is defined by the selected document type. Only

document types where the group is set to FileFile are available for selection. You define document types at

Organization administrationOrganization administration > Document managementDocument management > Document typesDocument types . The configuration for ER

destinations is the same as the configuration for the document management system.

The location determines where the file is saved. After the ArchiveArchive destination is enabled, the results can be

saved in the Job archive. You can view the results at Organization administrationOrganization administration > Electronic repor tingElectronic repor ting >

Electronic repor ting archived jobsElectronic repor ting archived jobs .

Select a document type for the Job archive by navigating to Organization administrationOrganization administration > WorkspacesWorkspaces >

Electronic repor tingElectronic repor ting > Electronic repor ting parametersElectronic repor ting parameters . For more information, see Configure the Electronic

reporting (ER) framework.

You can save a file in a designated SharePoint folder. To define the default SharePoint server, go to

Organization administrationOrganization administration > Document managementDocument management > Document management parametersDocument management parameters . On

the SharePointSharePoint tab, configure the SharePoint folder. Then, you can select it as the folder where the ER output

will be saved. The SharePointSharePoint location must be selected in this document type.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-destination-type-archive.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/organization-administration/configure-document-management#configure-document-types
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er_destinations-sharepointdocutype.png
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When the document type location is set to Azure storageAzure storage, you can save a file to Azure Storage.

The ER framework permanently stores files in Azure Blob storage unlike the Data management framework that applies the

seven-day retention policy for documents that must be processed. For more information, see API for getting message

status and Status check API. The ER-related files will be stored in Azure Blob storage as attachments of application table

records as long as necessary. A single file will be deleted from Azure Blob storage along with the application table record

that this file was attached to.

Electronic reporting (ER) overview

Electronic reporting (ER) destinations

Configure document management

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er_destinations-sharepointdocutypelocation.png
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/recurring-integrations
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/data-management-api
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Configure an email destination

When an Electronic reporting (ER) format is run, one or more outbound documents can be generated. FolderFolder  or

FileFile format components are used in ER formats to specify the structure of outbound documents. You can

configure an email destination for these types of components to send outbound documents as email

attachments.

You can configure an email destination for each FolderFolder  or FileFile component of an ER format. In this case, eacheach

outbound document is emailed individuallyoutbound document is emailed individually . Based on this destination setting, a generated document is

delivered as an attachment of an email.

If no document is generated, because the EnabledEnabled expression for the relevant FileFile component has been configured to

return a FalseFalse Boolean value, no email is sent, even if an email destination is configured and enabled for the component.

You can also group several FolderFolder  or FileFile components together, and then configure an email destination for all

the components in the group. In this case, all outbound documents that are generated by components that

belong to the group are sent as multiple attachments of a single emailare sent as multiple attachments of a single email . Based on this destination setting,

each generated document is delivered as an attachment of a single email.

If at least one document is generated by a FileFile component in a group of components, an email is sent. If no document is

generated by grouped components, because the EnabledEnabled expression for each FileFile component has been configured to

return a FalseFalse Boolean value, no email is sent, even if an email destination is configured and enabled for that group of

components.

EmailEmail is the only destination that can be configured for a group of components. To deliver a document that is emailed

based on the email destination setting for a group, add one more destination record, select the component that you

want, and then configure another destination for this record.

Multiple groups of components can be configured for a single ER format configuration. In this way, you can

configure an email destination for every group of components and an email destination for every component.

To send an output file or several output files by email, on the Electronic repor ting destinationElectronic repor ting destination page, on the

File destinationFile destination FastTab, select a component or group of components in the grid, and then select SettingsSettings . In

the Destination settingsDestination settings  dialog box that appears, on the EmailEmail  tab, set the EnabledEnabled option to YesYes . You can

then specify email recipients, and edit the subject and body of the email message. You can either set up constant

text for the email subject and body, or use ER formulas to dynamically create email texts.

You can configure email addresses for ER in two ways. The configuration can be completed in the same way that

the Print Management feature completes it, or you can resolve an email address by using a direct reference to

the ER configuration through a formula.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-destination-type-email.md


Email address types

Print Management emailPrint Management email

If you select EditEdit next to the ToTo or CcCc field in the Destination settingsDestination settings  dialog box, the Email toEmail to dialog box

appears. Select AddAdd, and then select the type of email address to use. Two types are currently supported: Pr intPr int

Management emailManagement email  and Configuration emailConfiguration email .

If you select Pr int Management emailPr int Management email  as the email address type, you can enter fixed email addresses in the

Email toEmail to dialog box by setting the following fields:

In the Email sourceEmail source field, select NoneNone.

In the Additional email addresses, separated by ";"Additional email addresses, separated by ";" field, enter the fixed email addresses.

Alternatively, you can obtain email addresses from the contact details of the party that you generate an

outbound document for. To use email addresses that aren't fixed, in the Email sourceEmail source field, select the role of the

party for a file destination. The following roles are supported:

Customer

Vendor

Prospect

Contact

Competitor

Worker

Applicant

Prospective vendor

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er_destinations-enablesingledestination.png
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Disallowed vendor

For example, to configure an email destination for an ER format that is used to process vendor payments, select

the VendorVendor  role.

After you select the desired role, select the BindBind button (chain symbol) next to the Email source accountEmail source account field

to open the Formula designer page. You can then use this page to configure a formula that returns, at runtime,

the account number of the party that is assigned to the configured role from the processed document to the

email destination.

Formulas are specific to the ER configuration.

On the Formula designerFormula designer  page, in the FormulaFormula field, enter a document-specific reference to a supported role.

Instead of typing the reference, in the Data sourceData source pane, find and select the data source node that represents

an account of the configured role, and then select Add data sourceAdd data source to update the formula. For example, if you

configure the email destination for the ISO 20022 Credit TransferISO 20022 Credit Transfer  configuration that is used to process

vendor payments, the node that represents a vendor account is 

'$PaymentsForCoveringLetter'.Creditor.Identification.SourceID .

If the account numbers of the configured role are unique for the whole instance of Microsoft Dynamics 365

Finance, the Company of email sourceCompany of email source field in the Email toEmail to dialog box can remain blank.

Alternatively, you might have a situation where different parties in the Global address book have been

registered in different companies (legal entities) in such a way that they all use the same account number to fill

the configured role. In this case, account numbers for the configured role aren't unique for the whole Finance

instance. Therefore, to explicitly select a party, you can't specify only an account number. You must also specify

the company that the party has been registered in the scope of to fill the configured role. Select the BindBind button

(chain symbol) next to the Company of email sourceCompany of email source field in the Email toEmail to dialog box to open the Formula

designer page. You can then use this page to configure a formula that returns, at runtime, the code of the

company that the desired source must be found in the scope of.
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Configuration emailConfiguration email

Group format components

If you must use the company code to run an ER format, but the ER format doesn't provide any data source that the

company code can be obtained from, configure the GetCurrentCompany()  formula by using the built-in

GETCURRENTCOMPANY ER function.

Formulas are specific to the ER configuration.

To specify the type of email addresses that must be used at runtime, in the Email toEmail to dialog box, select EditEdit next

to the ToTo field to open the Assign email addressAssign email address  drop-down dialog box. Then set the following fields:

In the PurposePurpose field, select the desire purposes. Only email addresses of the selected purposes from contacts

of the discovered party will be used.

Set the Pr imar y contactPr imar y contact option to YesYes  to use an email address that is configured for the discovered party

as the primary email address.

If purposes are selected in the PurposePurpose field and the Primar y contactPrimar y contact  option is set to YesYes at the same time, every

email that satisfies at least one configured criterion will be used at runtime.

Select Configuration emailConfiguration email  as the email address type if the configuration that you use has a node in the data

sources that returns either a single email address or multiple email addresses that are separated by semicolons

(;). You can use data sources and functions in the formula designer to get a correctly formatted email address or

correctly formatted email addresses that are separated by semicolons. For example, if you use the ISO 20022ISO 20022

Credit TransferCredit Transfer  configuration, the node that represents the primary email address of a vendor from the vendor

contact details that the covering letter should be sent to is 

'$PaymentsForCoveringLetter'.Creditor.ContactDetails.Email .

To group format components, on the Electronic repor ting destinationElectronic repor ting destination page, on the File destinationFile destination

FastTab, select the components in the grid, and then select GroupGroup.

EmailEmail  is the only previously configured destination that is still available for the selected components. No other

previously configured destinations are available, because they are considered unsupported for a group of

components. You will be notified about these changes as appropriate.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er_destinations-emaildefineaddresssource2.png
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The record that you previously added is considered the header of the group that is created. This header record

holds the email destination settings for the group. Other records are group members that will use the email

destination settings of the group's header record.

To ungroup format components, on the File destinationFile destination FastTab, select a record that belongs to the group, and

then select UngroupUngroup.

If you select a header record, the whole group will be ungrouped.

If you select a member record, and it's the last member record in a group, the whole group will be

ungrouped.

If you select a member record that isn't the last member record in a group, that record will be excluded from

the current group.

The following illustration shows the structure of an ER format that was configured to produce a zipped

outbound file that contains a collection letter note and appropriate customer invoices in PDF format.

The following illustration shows the process, as described in this topic, of grouping individual components and

enabling the EmailEmail  destination for the new group, so that a collection letter note is sent together with

appropriate customer invoices as email attachments.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er_destinations-email-grouping1.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er_destinations-email-grouping2.gif


NOTENOTE

Electronic reporting (ER) overview

Electronic reporting (ER) destinations

Formula designer in Electronic reporting (ER)

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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You can configure a file destination for each FOLDER or FILE component of an Electronic reporting (ER) format

that is configured to generate outbound documents. Based on the setting of the destination, a generated

document is available for download from the web browser.

On the Destination settingsDestination settings  page, if you set EnabledEnabled to YesYes , an open or save dialog box opens when the

configuration has finished running.

Electronic reporting (ER) overview

Electronic reporting (ER) destinations

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-destination-type-file.md
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er_destinations-enablefiledestination.png
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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You can configure a Microsoft Power BI destination for each folder or file component of an Electronic reporting

(ER) format that is configured to generate outbound documents. Based on the setting of the destination, a

generated document is stored in a previously configured SharePoint folder.

Set EnabledEnabled to YesYes  to use your ER configuration to arrange the transfer of data from your Dynamics 365

Finance instance to Microsoft Power BI services. The transferred files are stored on a Microsoft SharePoint

Server instance that must be configured for that purpose. For more information, see Configure Electronic

reporting (ER) to pull data into Power BI.

Electronic reporting (ER) overview

Electronic reporting (ER) destinations

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-destination-type-powerbi.md
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er_destinations-enablepowerbidestination.png
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Prerequisites

Make the Printer destination available

ApplicabilityApplicability

LimitationsLimitations

Use the Printer destinationUse the Printer destination

You can send a generated document directly to a network printer for direct printing.

Before you begin, you must install and configure the Document Routing Agent, and then register the network

printers. For more information, see Install the Document Routing Agent to enable network printing.

To make the Pr interPr inter  destination available in the current instance of Microsoft Dynamics 365 Finance, go to the

Feature managementFeature management workspace, and turn on the following features, in this order :

1. Convert Electronic Reporting outbound documents from Microsoft Office formats to PDF

2. Document Routing Agent as Electronic Reporting destination for outbound documents

The Pr interPr inter  destination can be configured only for file components that are used to generate output in either

printable PDF format (PDF Merger or PDF file format elements) or Microsoft Office Excel/Word format (Excel

file). When output is generated in PDF format, it's sent to a printer. When output is generated in Microsoft Office

format, it's automatically converted to PDF format and then sent to a printer.

This feature is a preview feature and is subject to the terms of use that are described in Supplemental Terms of

Use for Microsoft Dynamics 365 Previews.

The Pr interPr inter  destination is implemented only for cloud deployments.

1. Set the EnabledEnabled option to YesYes  to send a generated document to a printer.

2. In the Pr inter namePrinter name field, select the required network printer.

3. Set the Save in pr int archive?Save in pr int archive? option to YesYes  to store the generated output in the print archive, so that it's

available for further printing. To access archived output later, go to Organization administrationOrganization administration >

Inquir ies and repor tsInquir ies and repor ts  > Repor t archiveRepor t archive.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-destination-type-print.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/install-document-routing-agent
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er_destinations-enableprinterdestinationfeature.png
https://go.microsoft.com/fwlink/?linkid=2105274


NOTENOTE

Additional resources

NOTENOTE

The Conver t to PDFConver t to PDF option doesn't have to be turned on when you configure the PrinterPrinter  destination. The PDF

conversion for printing purposes will occur even if the option is turned off.

To use a specific page orientation when you print an outbound document in Excel format, you must turn on the

Conver t to PDFConver t to PDF option. When you set the Conver t to PDFConver t to PDF option to YesYes , the Page or ientationPage or ientation field

becomes available. In the Page or ientationPage or ientation field, you can select a page orientation.

Electronic reporting (ER) overview

Electronic reporting (ER) destinations

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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You can configure a screen destination for each folder or file component of an Electronic reporting (ER) format

that is configured to generate outbound documents. Based on the setting of the destination, a generated

document is opened for preview in a separate browser tab.

If you set EnabledEnabled to YesYes , a preview of the output is created. You can view some file types, such as XML, TXT, or

PDF, directly in a browser window. For other file types, such Microsoft Excel or Word, the Microsoft Office Online

service is used.

Electronic reporting (ER) overview

Electronic reporting (ER) destinations

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-destination-type-screen.md
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This procedure demonstrates how to set up and use different destinations for Electronic reporting (ER) output

components, such as a folder or a file. The demo data company used to create this procedure is DEMF. Germany

is the country\region of the legal entity's primary address, however you can use any legal entity for this

procedure.

The format used in this example is ISO20022 Credit transfer, but you can use any format that you have already

imported. Note, this procedure is an example of a single file and a single destination setup. More information

about Electronic reporting destination management can be found in the Dynamics 365 Finance Help.

1. Go to Organization administration > Electronic reporting > Electronic reporting destination.

2. Click New to create a new set of destinations for a format.

3. In the Reference field, select a format for which you want to configure destinations.

4. Click New to create a new file destination.

5. In the Name field, enter the user-friendly name of output component.

6. In the File name, select a file or folder that is specific to the format.

7. Click Settings.

8. Select Yes in the Enabled field.

9. Click Edit, to set up email recipients.

10. Click Add.

11. Click Print Management email.

12. In the Email source field, select an option.

13. Click Email source bind button.

14. In the Formula, enter a document-specific reference to a party type that you selected earlier.

15. Click Save.

16. Close the page.

17. Click Edit to configure contact details for the party.

If you don't have a value to select, it means that you have not imported any Electronic reporting

format configurations. You must import a format configuration before setting up destinations.

Note, you can create one file destination for each output component of the same format, such as a

folder or a file. You will be able to enable and disable destinations separately in the settings.

We recommend that you use meaningful names, such as "Payment file" or "Control report". These

names will be presented to users at configuration runtime along with the destination settings.

The Enabled check box on each tab enables and disables each destination separately. In this example,

you'll enable sending an output file to a mail recipient when the file is generated.

You can select different email source types, such as a customer or a vendor type. This defines the type

of argument that will be returned by the Email source account formula. The Email source account

formula, described in a following step, is the place where you bind an email source. Select Vendor if

your formula will return a vendor account. Use Vendor if you are using the ISO 20022 Credit Transfer

configuration example.

Instead of typing, you can find a data source node that represents the party account, and click the Add

data source button to update the formula. For example, if you use the ISO 20022 Credit Transfer

configuration, the node representing a vendor account is

'$PaymentsForCoveringLetter'.Creditor.Identification.SourceID. Otherwise, enter any string value, such

as "DE-001", to save a formula.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/tasks/er-destinations-2016-11.md
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18. Select Yes in the Primary contact field.

19. Click OK.

20. Click OK.

21. In the Subject field, type a value.

22. Click OK.

You may use different options to indicate what contact type of the party should be used as an email

address for this destination. We use primary contact in this example.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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You can use the Electronic reporting (ER) framework to configure formats for outbound documents in

accordance to the legal requirements of various countries/regions. You can also use the ER framework to

configure formats for parsing inbound documents and use the information from those documents to append or

update application data. Each of these formats can be used in your Dynamics 365 Finance instance for handling

inbound or outbound business documents as part of a certain business process.

Usually, you must specify what ER format must be used in a certain business process. To do that, select a single

ER format in a lookup field that is configured as part of business process-specific parameters. These lookup

fields are usually implemented by using the appropriate API of the ER framework. For more information, see ER

framework API - code to display a format mapping lookup.

For example, when you configure foreign trade parameters, you need to set up the references to individual ER

formats that will be used to generate the Intrastat declaration and the Intrastat declaration control report. The

screenshots below show how the ER formats lookup field looks like in the Foreign trade parametersForeign trade parameters  page.

If the current Finance instance contains no Intrastat business process-related ER formats, this lookup field will be

empty.

If the current Finance instance contains Intrastat business process related ER formats, this lookup field offers the

ER formats.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-extended-format-lookup.md
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/emea-intrastat#set-up-foreign-trade-parameters
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er-extlookup-lookup1.gif


This lookup offers only the ER formats that have already been imported to the current Finance instance. To

import ER solutions to the current Finance instance, you need to have permissions to run the appropriate

function of the ER framework that supports the lifecycle of ER solutions that contain ER formats.

Starting in the Finance version 10.0.9 (April 2020 release), the user interface of the ER format lookup that is

implemented by using the ER framework API, has been extended. You can still select the existing ER formats,

which on the Select format configurationSelect format configuration FastTab. In addition, the extended lookup offers the new option to

search the Global repository (GR) to locate specific ER formats. All ER formats of the GR are offered on the

Impor t from Global repositor yImpor t from Global repositor y  FastTab.

Similar to the Select format configurationSelect format configuration FastTab, the Impor t from Global repositor yImpor t from Global repositor y  FastTab shows

only the ER formats that are applicable to the business process for which an ER format is selected in this lookup

field. In this example, the generation of Intrastat declaration. The ER format is applicable for the company to

which the user is currently signed in, depending on the company country context.

When you select an ER format on the Impor t from Global repositor yImpor t from Global repositor y  FastTab, the selected ER format

configuration is imported from the GR to the current Finance instance.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er-extlookup-lookup2.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er-extlookup-lookup3.png


Feature activation

Then, if the import completes successfully, the reference to the imported ER format is stored in this lookup field.

When you access the GR for the first time, you need to follow the link provided to sign up for the Regulatory

Configuration Service (RCS) that is used to manage access to the GR storage.

By default, the Impor t from Global repositor yImpor t from Global repositor y  FastTab presents the list of ER formats from the temporary

storage that is automatically created based on the GR content for performance improvements. This happens

when the Impor t from Global repositor yImpor t from Global repositor y  FastTab is opened the first time, which may take several seconds.

If you do not see the required ER format in the Impor t from Global repositor yImpor t from Global repositor y  FastTab, but you are sure that

this ER format is stored in the GR, select the SynchronizeSynchronize option. This option will update the temporary storage

and synchronize it with the current content of the GR.

The availability of this functionality is controlled by the feature Extended lookup of ER formatExtended lookup of ER format

configurations allowing to inquire the Global repositor yconfigurations allowing to inquire the Global repositor y  in the Feature managementFeature management. This feature is

enabled by default.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er-extlookup-formatimport.png
https://aka.ms/rcs
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Security considerations

Limitations

Frequently asked questions
Why can't I access the Global repository from the ER format lookup?Why can't I access the Global repository from the ER format lookup?

The Maintain configuration repositor iesMaintain configuration repositor ies  (ERMaintainSolutionRepositor iesERMaintainSolutionRepositor ies ) privilege controls access to

the GR for a user opening the ER format lookup with the enabled Impor t from Global repositor yImpor t from Global repositor y  FastTab. To

allow users to access the GR content from the ER format lookups, you need to change the security settings by

granting the ERMaintainSolutionRepositor iesERMaintainSolutionRepositor ies  privilege to users either directly or by using already assigned

roles and duties.

The following screenshot shows how this privilege can be granted to users who are assigned to the AccountantAccountant

role. This role allows users to configure foreign trade parameters and set up references to the ER formats in the

File format mappingFile format mapping and Repor t format mappingRepor t format mapping fields on the Foreign trade parametersForeign trade parameters  page.

Access to the GR in the ER format lookup is currently only supported for the selection of ER formats that are

used to generate outbound documents.

If you have enabled the Extended lookup of ER format configurations allowing to inquire the GlobalExtended lookup of ER format configurations allowing to inquire the Global

repositor yrepositor y  feature on the Feature managementFeature management page, but users can't see ER formats on the Impor t fromImpor t from

Global repositor yGlobal repositor y  FastTab and the SynchronizeSynchronize option is visible but disabled, make sure that the MaintainMaintain

configuration repositor iesconfiguration repositor ies  (ERMaintainSolutionRepositor iesERMaintainSolutionRepositor ies ) privilege has been granted to the user.

Contact your system administrator to receive this privilege.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/er-extlookup-featuremngt.png
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Additional resources
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Example: Trace generated report results and compare them with
baseline values

You can trace the results of Electronic reporting (ER) formats that generate outgoing electronic documents.

When trace generation is turned on (by using the Run in debug modeRun in debug mode ER user parameter), a new trace record

is generated in the ER format execution log every time that an ER report is run. The following details are stored

in each trace that is generated:

All warnings that were generated by validation rules

All errors that were generated by validation rules

All generated files that are stored as attachments of the trace record

You can store individual baseline application files for any ER format. Files are considered baseline files when

they describe the expected results of reports that are run. If a baseline file is available for an ER format that is

run while trace generation is turned on, the trace stores, in addition to the details that were mentioned earlier,

the result of the comparison of the generated electronic document with the baseline file. In one click, you can

also get the generated electronic document and its baseline file in a single zip file. You can then do detailed

comparison by using an external tool such as WinDiff.

You can evaluate the trace to analyze whether the electronic documents that are generated include the expected

content. You can do this evaluation in a user acceptance testing (UAT) environment when the code base has been

changed (for example, when you migrated to a new instance of the application, installed hotfix packages, or

deployed code modifications). In this way, you can make sure that the evaluation doesn't affect the execution of

ER reports that are used. For many ER reports, the evaluation can be done in unattended mode.

To learn more about this feature, play the ER Generate repor ts and compare results (Par t 1)ER Generate repor ts and compare results (Par t 1)  and ERER

Generate repor ts and compare results (Par t 2)Generate repor ts and compare results (Par t 2)  task guides, which are part of the 7.5 .4 .3 Test IT7.5 .4 .3 Test IT

ser vices/solutions (10679)ser vices/solutions (10679)  business process and can be downloaded from the Microsoft Download Center.

These task guides walk you through the process of configuring the ER framework to use baseline files to

evaluate generated electronic documents.

This procedure explains how to configure the ER framework to collect information about ER format executions

and then evaluate the results of those executions. As part of that evaluation, generated documents are

compared with their baseline files. In this example, you will create the required ER configurations for the Litware,

Inc. sample company. This procedure is intended for users who have the System administrator or Electronic

reporting developer role assigned to them. These steps can be completed by using any data set.

To complete the steps in this example, you must first complete the steps in Create configuration providers and

mark them as active.

1. Go to Organization administrationOrganization administration > WorkspacesWorkspaces  > Electronic repor tingElectronic repor ting.

2. On the Localization configurationsLocalization configurations  page, in the Configuration providersConfiguration providers  section, verify that the

configuration provider for the Litware, Inc. sample company is listed, and that it's marked as ActiveActive. If you

don't see this configuration provider, follow the steps in Create configuration providers and mark them as

active.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-trace-reports-compare-baseline.md
https://go.microsoft.com/fwlink/?linkid=874684


Configure document management parametersConfigure document management parameters
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Configure ER parameters to start to use the baseline featureConfigure ER parameters to start to use the baseline feature

1. Go to Organization administrationOrganization administration > Document managementDocument management > Document typesDocument types , and create a new

document type to store baseline files.

2. In the ClassClass  field, enter Attach fileAttach file.

3. In the GroupGroup field, enter FileFile.

A new document type that has the same name must be configured for each data set where you plan to use the ER

baseline feature.

1. In the Electronic repor tingElectronic repor ting workspace, in the Related linksRelated links  section, select Electronic repor tingElectronic repor ting

parametersparameters .

2. On the AttachmentsAttachments  tab, in the BaselineBaseline field, enter or select the document type that you just created.



Add a new ER model configurationAdd a new ER model configuration

Design a data modelDesign a data model

3. Select SaveSave, and then close the Electronic repor ting parametersElectronic repor ting parameters  page.

1. In the Electronic repor tingElectronic repor ting workspace, in the ConfigurationsConfigurations  section, select the Repor tingRepor ting

configurationsconfigurations  tile.

2. On the Action Pane, select Create configurationCreate configuration.

3. In the drop-down dialog box, in the NameName field, enter Model to learn ER baselinesModel to learn ER baselines .

4. Select Create configurationCreate configuration to confirm the creation of a new ER data model entry.

1. On the ConfigurationsConfigurations  page, on the Action Pane, select DesignerDesigner .

2. Select NewNew .

3. In the drop-down dialog box, in the NameName field, enter RootRoot.

4. Select AddAdd.

5. Select Root referenceRoot reference.

6. Select OKOK, and then select SaveSave.

7. Close the Model designerModel designer  page.

8. Select Change statusChange status .

9. Select CompleteComplete, and then select OKOK.



Add a new ER format configurationAdd a new ER format configuration

Design a formatDesign a format

1. On the ConfigurationsConfigurations  page, on the Action Pane, select Create configurationCreate configuration.

2. In the drop-down dialog box, in the NewNew  field group, select Format based on data model Model toFormat based on data model Model to

learn ER baselineslearn ER baselines .

3. In the NameName field, enter Format to learn ER baselinesFormat to learn ER baselines .

4. Select Create configurationCreate configuration to confirm the creation of a new ER format entry.

For this example, you will create a simple ER format to generate XML documents.

1. On the ConfigurationsConfigurations  page, on the Action Pane, select DesignerDesigner .

2. Select Add rootAdd root.

3. In the drop-down dialog box, follow these steps:

a. In the tree, select Common\FileCommon\File.

b. In the NameName field, enter OutputOutput.

c. Select OKOK.



4. Select AddAdd.

5. In the drop-down dialog box, follow these steps:

a. In the tree, select XML\ElementXML\Element.

b. In the NameName field, enter DocumentDocument.

c. Select OKOK.

6. In the tree, select Output\DocumentOutput\Document.

7. Select AddAdd.

8. In the drop-down dialog box, follow these steps:

a. In the tree, select XML\Attr ibuteXML\Attr ibute.

b. In the NameName field, enter IDID.

c. Select OKOK.

9. On the MappingMapping tab, select DeleteDelete.

10. Select Add rootAdd root.

11. In the drop-down dialog box, in the tree, select General\User input parameterGeneral\User input parameter , and then follow these

steps:

a. In the NameName field, enter IDID.

b. In the LabelLabel  field, enter Enter IDEnter ID.

c. Select OKOK.

12. In the tree, select Output\Document\IdOutput\Document\Id.

13. Select BindBind, and then select SaveSave.



Generate a new baseline file for a designed ER formatGenerate a new baseline file for a designed ER format

Configure ER parameters to use the baseline featureConfigure ER parameters to use the baseline feature

Based on the designed structure, the configured format will generate an XML file. This XML contains the RootRoot

element that has the IDID attribute that is set to the value that the user enters in the ER runtime dialog box.

1. On the ConfigurationsConfigurations  page, on the VersionsVersions  FastTab, select RunRun.

2. In the Enter IDEnter ID field, enter 11 .

3. Select OKOK.

4. Save a local copy of the out.Admin.xmlout.Admin.xml  file that is generated, so that you can use it later as a baseline for

this ER format.

1. On the ConfigurationsConfigurations  page, on the Action Pane, on the ConfigurationsConfigurations  tab, select User parametersUser parameters .

2. Set the Run in debug modeRun in debug mode option to YesYes .

3. Select OKOK.



Add a new baseline for designed ER formatAdd a new baseline for designed ER format

Configure a baseline rule for the added baselineConfigure a baseline rule for the added baseline

1. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > ConfigurationsConfigurations .

2. On the Action Pane, select BaselinesBaselines .

3. On the Action Pane, select NewNew .

4. Select the Format to learn ER baselinesFormat to learn ER baselines  ER format that you designed earlier.

5. Select SaveSave.

The baseline is added for the Format to learn ER baselinesFormat to learn ER baselines  format.

1. On the Electronic repor ting format baselinesElectronic repor ting format baselines  page, on the Action Pane, select the AttachmentsAttachments

button (the paper clip symbol).

2. On the Action Pane, select NewNew  > FileFile. In the ER parameters, the FileFile document type should have been

previously selected as the document type that is used to store baseline files.

3. Select BrowseBrowse, and select the out.Admin.xmlout.Admin.xml  file that was generated when you ran the configured ER

format earlier.



Run the designed ER format and review the log to analyze the resultsRun the designed ER format and review the log to analyze the results

NOTENOTE

4. Close the AttachmentsAttachments  page.

5. On the BaselinesBaselines  FastTab, select NewNew .

6. In the NameName field, enter Baseline 1Baseline 1 .

7. In the File component nameFile component name field, enter or select OutputOutput. This value indicates that the configured

baseline will be compared with a file that is generated by using the OutputOutput format element.

8. In the File name maskFile name mask field, enter * .xml*.xml .

You can define the file name mask. When the file name mask is defined, the baseline record will be used to

evaluate the generated output only when the name of the output file that is generated satisfies that mask.

9. If the configured baseline should be used only when the Format to learn ER baselinesFormat to learn ER baselines  ER format is

run by users who are signed in to specific companies, select those companies in the CompaniesCompanies  field.

10. In the BaselineBaseline field, enter or select the out.Adminout.Admin attachment.

11. Select SaveSave.

1. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > ConfigurationsConfigurations .



Run the designed ER format and review the log to analyze the resultsRun the designed ER format and review the log to analyze the results

NOTENOTE

2. In the tree, expand Model to learn ER baselinesModel to learn ER baselines , and then select Model to learn ERModel to learn ER

baselines\Format to learn ER baselinesbaselines\Format to learn ER baselines .

3. On the VersionsVersions  FastTab, select RunRun.

4. In the Enter IDEnter ID field, enter 11 .

5. Select OKOK.

6. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > Configuration debug logsConfiguration debug logs .

The execution log contains information about the results of the comparison of the generated file with the

configured baseline. In this example, the log indicates that the generated file and the baseline are equal.

7. Select Delete allDelete all .

1. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > ConfigurationsConfigurations .

2. In the tree, expand Model to learn ER baselinesModel to learn ER baselines , and then select Model to learn ERModel to learn ER

baselines\Format to learn ER baselinesbaselines\Format to learn ER baselines .

3. On the VersionsVersions  FastTab, select RunRun.

4. In the Enter IDEnter ID field, enter 22 .

5. Select OKOK.

6. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > Configuration debug logsConfiguration debug logs .
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Additional resources

NOTENOTE

NOTENOTE
The execution log contains information about the results of the comparison of the generated file with the

configured baseline. In this example, the log indicates that the generated file and the baseline differ.

7. Select CompareCompare.

The generated file and the baseline file are offered as a zip file. You can use external comparison tools such as WinDiff to

compare the files and review the differences.

Configure the Electronic reporting (ER) framework

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Automate the setting of baseline rules

NOTENOTE

Example: Automate the setting of baseline rules

Review added baselineReview added baseline

This topic describes the first set of improvements that have been made to the baseline feature of the Electronic

reporting (ER) framework. These improvements are available in Microsoft Dynamics 365 for Finance and

Operations version 10.0.3 (June 2019) and later.

The Trace generated report results and compare them with baseline values topic explains how to configure the

ER framework to collect information about ER format executions and evaluate the results of those executions.

The example in this topic shows the steps that must be completed.

Here are some of the steps:

Run an ER format to generate an outbound file, and store the file locally.

Add the locally stored file as an attachment of the baseline that was added for an ER format.

Configure the baseline rule for the added baseline. This configuration includes the following steps:

Specify an ER format element that is used to generate an outbound file.

Select the attachment that refers to the generated outbound file.

These steps must be done manually, even though the new ER capabilities enable them to be automated. To learn more

about this feature, complete the following example.

To complete the steps in this example, you must first complete the steps in the example in the Trace generated

report results and compare them with baseline values topic, up through the "Add a new baseline for a designed

ER format" section.

NOTENOTE

1. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > ConfigurationsConfigurations .

2. Select BaselinesBaselines .

The BaselinesBaselines button on the Action Pane is available only when the Run in debug modeRun in debug mode ER user parameter is

turned on for the current company.

The baseline has been added for the selected Format to learn ER baselinesFormat to learn ER baselines  format, but the baseline rules

haven't yet been added for this baseline.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-trace-reports-compare-baseline-replace.md


Make a new baseline ruleMake a new baseline rule

Run the formatRun the format

1. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > ConfigurationsConfigurations .

2. In the tree, expand Model to learn ER baselinesModel to learn ER baselines .

3. In the tree, select Model to learn ER baselines\Format to learn ER baselinesModel to learn ER baselines\Format to learn ER baselines .

4. On the VersionsVersions  FastTab, select RunRun.

5. In the Enter IdEnter Id field, enter 11 .

6. Set the Make baseline filesMake baseline files  option to YesYes .

7. Select OKOK.

8. Select BaselinesBaselines .

The generated outbound file has been automatically attached to the baseline of the executed ER format.

The baseline rule has been automatically added to this baseline and also contains the reference to the

attached file.

9. In the NameName field, enter Baseline 1Baseline 1 .

10. In the File name maskFile name mask field, enter .xml.xml .

11. Select SaveSave.

You're now ready to complete the remaining steps in the example in the Trace generated report results and

compare them with baseline values topic, starting from the "Run the designed ER format and review the log to
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Configure the baseline so that it ignores constantly changing parts of
the ER output

Example: Configure the baseline so that it ignores constantly
changing parts of the ER output

Modify a configured ER formatModify a configured ER format

analyze the results" section.

When you delete the automatically added baseline rule on the BaselinesBaselines FastTab, the referenced attachment isn't

automatically deleted.

When an ER format has been designed to contain information that is changed when the format is run, the

format must be required to use the ER baseline feature to compare the generated results with baseline values.

For example, the information might be the processing date and time or the unique identifier of a generated

document in different formats (globally unique identifier [GUID], and so on). The new ER capabilities let you

configure the baseline rule so that it ignores changeable elements of an ER format when the format is run with

the purpose of comparing baseline values with the results of the format's execution. To learn more about this

feature, complete the following example.

To complete the steps in this example, you must first complete the steps in the example in the Trace generated

report results and compare them with baseline values topic.

1. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > ConfigurationsConfigurations .

2. In the tree, expand Model to learn ER baselinesModel to learn ER baselines .

3. In the tree, select Model to learn ER baselines\Format to learn ER baselinesModel to learn ER baselines\Format to learn ER baselines .

4. Select DesignerDesigner .

5. In the tree, select Output\DocumentOutput\Document.

6. Select AddAdd.

7. In the drop-down dialog box, in the tree, select XML\Attr ibuteXML\Attr ibute.

8. In the NameName field, enter ProcessingDateTimeProcessingDateTime.

9. Select OKOK.

10. On the MappingMapping tab, in the tree, select Output\Document\ProcessingDateTimeOutput\Document\ProcessingDateTime.

11. Select Edit formulaEdit formula.

12. In the FormulaFormula field, enter the following expression: DATETIMEFORMAT(NOW(), "O")DATETIMEFORMAT(NOW(), "O")

13. Select SaveSave, and then select TestTest.

14. Select TestTest again to retest the configured expression.



Remove an existing baseline ruleRemove an existing baseline rule

NOTENOTE
The Test resultTest result  tab shows that the configured expression returns a different date and time value whenever it's

called.

15. Close the Formula designerFormula designer  page, and then select SaveSave.

16. Close the Format designerFormat designer  page.

1. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > ConfigurationsConfigurations .

2. Select BaselinesBaselines .

3. In the list of baselines, select the baseline that is configured for the Format to learn ER baselinesFormat to learn ER baselines  format.

4. On the BaselinesBaselines  FastTab, select DeleteDelete to remove the baseline rule that you configured earlier.



Define replacements for bindings of designed ER formatDefine replacements for bindings of designed ER format

Make a new baseline ruleMake a new baseline rule

1. On the ConfigurationsConfigurations  page, on the ReplacementsReplacements  FastTab, select Select componentsSelect components .

2. In the format components tree, expand OutputOutput, expand Output\DocumentOutput\Document, and then select the check box

for Output\Document\ProcessingDateTimeOutput\Document\ProcessingDateTime.

3. Select OKOK.

The selected ER format component has been added to the list of components on the ReplacementsReplacements  FastTab.

When the base ER format is run in debug mode, the format's binding for each component will be replaced by

the binding that is shown in the BindingBinding column. To change the default binding for a component that is listed

on the ReplacementsReplacements  FastTab, select EditEdit.

Follow the steps in the "Example: Automate the setting of baseline rules" section earlier in this topic. A

notification warns you that the outbound file has been generated by using baseline settings, and that a forced

replacement of the format bindings has occurred.



Suppress warnings about the replacement of format bindingsSuppress warnings about the replacement of format bindings

Review the generated baseline fileReview the generated baseline file

Run the designed ER format and review the log to analyze the resultsRun the designed ER format and review the log to analyze the results

By setting specific ER parameters, you can suppress notifications that warn about the replacement of format

bindings. This suppression can be useful when format bindings are replaced in an unattended mode by using

the Regression Suite Automation Tool. In this case, the warning can be considered a failure of the test case that is

running.

1. On the ConfigurationsConfigurations  page, on the Action Pane, on the ConfigurationsConfigurations  tab, select User parametersUser parameters .

2. Set the Suppress baseline warningsSuppress baseline warnings  option to YesYes , and then select OKOK.

NOTENOTE

1. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > ConfigurationsConfigurations .

2. Select BaselinesBaselines .

3. Select AttachmentsAttachments .

The generated file contains the processing date and time text ("#""#") from the binding that was configured in the

added baseline rule, not from the format's binding.

4. Close the AttachmentsAttachments  page.

1. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > ConfigurationsConfigurations .

2. In the tree, expand Model to learn ER baselinesModel to learn ER baselines .

3. In the tree, select Model to learn ER baselines\Format to learn ER baselinesModel to learn ER baselines\Format to learn ER baselines .

4. On the VersionsVersions  FastTab select RunRun.

5. In the Enter IdEnter Id field, type 11 .

6. Select OKOK.

7. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > Configuration debug logsConfiguration debug logs .

The execution log contains information about the results of the comparison of the generated file with the

configured baseline. The log indicates that the generated file and the baseline are equal, even though the

executed format contains the binding to enter a constantly changing date and time value in the outbound file.



NOTENOTE

Exchange baseline settings between environments
Export baseline settingsExport baseline settings

Import baseline settingsImport baseline settings

Although the outbound file has been generated by using baseline settings that force the replacement of the format's

bindings, you don't receive any warnings about the replacement.

The new ER capabilities let you export baseline settings for the selected ER format from the current environment

and store them as XML files.

To export baseline settings, on the Electronic repor ting format baselinesElectronic repor ting format baselines  page, select Expor tExpor t.

Exported baseline settings can be imported into a different environment. The environment must first be

imported as an ER format. You can then import the baseline settings.

To import baseline settings from a locally stored XML file, on the Electronic repor ting format baselinesElectronic repor ting format baselines

page, select Impor tImpor t, and then select BrowseBrowse to select the XML file.

To import baseline settings from an XML file that is stored on the Microsoft SharePoint Server, based on the

current Document management settings and the selected document type, on the Electronic repor ting formatElectronic repor ting format

baselinesbaselines  page, select Impor t from sourceImpor t from source. Then select the document type and the XML file. The required

document type to access the SharePoint folder must be configured in advance.



NOTENOTE

Additional resources

NOTENOTE

You can use Task recorder to record the steps for selecting the required document type and the file name in the Impor tImpor t

from sourcefrom source dialog box. In this way, you can keep required baseline settings on SharePoint Server and then

automatically import them by playing a task recording when you run automated tests by using the Regression Suite

Automation Tool.

Trace generated report results and compare them with baseline values

Task recorder resources

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Automate testing with Electronic reporting
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Key concepts

This topic explains how you can use the Electronic reporting (ER) framework to automate testing of some

functionality. The example in this topic shows how to automate the testing of vendor payment processing.

The application uses the ER framework to generate payment files and corresponding documents during vendor

payment processing. The ER framework consists of a data model, model mappings, and format components that

support payment processing for different payment types and the generation of documents in different formats.

These components can be downloaded from Microsoft Dynamics Lifecycle Services (LCS) and imported into the

instance.

You also can customize each Microsoft component and use it as the basis of your own custom component. By

creating a custom version, you can make changes that support specific requirements. For example, you can

adjust the ER data model and ER model mapping to access customer-specific application data, or you can

change an ER format to modify the layout of a generated document.

You can use customized ER formats to process payment files that generate vendor payments and also to process

control reports. Versioning is supported in ER components. Therefore, Microsoft can provide updated versions

of ER solutions for vendor payment processing, and you can automatically merge the updated version with your

customized component by rebasing it. However, you must test the rebased version to make sure that it works as

you expect.

ER data models and ER model mappings are common for many ER formats that are used to process payments

of different types and to generate country/region-specific payment documents. Therefore, it's highly desirable to

automate user acceptance and integration testing so that it's automatically done in multiple companies but

considers the country/region context of each target company, uses different datasets, and so on.

For more information about how to create a custom version of a format that is based on the format that you

received from a configuration provider, see ER Upgrade your format by adopting a new, base version of that

format.

Functional power users can author user acceptance and integration testing without having to write source code.

Use the ER baseline feature to compare generated documents to master copies. For more information,

see Trace generated report results and compare them with baseline values.

Use Task recorder to record test cases, and include baseline assessment. For more information, see Task

recorder resources.

Group test cases for required test scenarios. For more information, see Create and automate user

acceptance tests.

Use Business process modeler (BPM) in LCS to make libraries for user acceptance tests.

Use BPM test libraries to create a test plan and test suites in Microsoft Azure DevOps Services (Azure

DevOps).

Functional power users can run user acceptance and integration tests.

Use Regression suite automation tool (RSAT) to run test cases of the desired test suite.

Report the results of the testing to Azure DevOps, and use this service to investigate those results.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-automate-testing.md


  Prerequisites
Before you can complete the tasks in this topic, you must complete the following prerequisites:

C O N T EN TC O N T EN T F IL E  N A M E A N D LO C AT IO NF IL E  N A M E A N D LO C AT IO N

Sample task recording to prepare data for testing Prepare\Recording.xml

Sample task recording to process vendor payment Process\Recording.xml

Deploy a topology that supports test automation. You must have access to the instance of this topology

for the System administratorSystem administrator  role. This topology must contain the demo data that will be used in this

example. For more information, see Deploy and use an environment that supports continuous build and

test automation.

To run user acceptance and integration tests automatically, you must install RSAT in the topology that

you're using and configure it in the appropriate manner. For information about how to install and

configure RSAT and configure it to work with Finance and Operations apps and Azure DevOps, see

Regression Suite Automation Tool. Pay attention to the prerequisites for using the tool. The following

illustration shows an example of the RSAT settings. The blue rectangle encloses the parameters that

specify access to Azure DevOps. The green rectangle encloses the parameters that specify access to the

instance.

To organize test cases in suites to help guarantee the correct execution sequence, so that you can collect

logs of test executions for further reporting and investigation, you must have access to Azure DevOps

from the deployed topology.

To complete the example in this topic, we recommend that you download ER usage for RSAT tests. This

zip file contains the following task guides:

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/perf-test/continuous-build-test-automation
https://www.microsoft.com/download/details.aspx?id=57357
https://go.microsoft.com/fwlink/?linkid=874684


Prepare the Accounts payable module to process vendor payments

NOTENOTE

1. Sign in to your instance.

2. Download the following ER configurations from LCS. For instructions, see ER Import a configuration from

Lifecycle Services.

Payment modelPayment model  ER model configuration

Payment model mapping 1611Payment model mapping 1611  ER model mapping configuration

BACS (UK)BACS (UK)  ER format configuration

3. Select the GBSIGBSI demo data company, which has a country/region context in Great Britain.

4. Configure Accounts payable parameters:

a. Go to Accounts payable > Payment setup > Methods of paymentAccounts payable > Payment setup > Methods of payment.

b. Select the ElectronicElectronic method of payment.

c. Configure the selected method of payment so that it uses the BACS (UK)BACS (UK)  ER format that you

downloaded earlier for vendor payment processing:

a. On the File formatsFile formats  FastTab, set the Generic electronic Expor t formatGeneric electronic Expor t format option to YesYes .

b. In the Expor t format configurationExpor t format configuration field, select BACS (UK)BACS (UK) .

If you have the derived version of this ER format that was created to support customizations, you can select this

configuration in the ElectronicElectronic method of payment.

5. Create an example vendor payment:

a. Go to Accounts payable > Payments > Payment journalAccounts payable > Payments > Payment journal .

b. Make sure that you haven't posted the payment journal.



Prepare the ER framework to test vendor payment processing
Configure ER parametersConfigure ER parameters

Generate baseline copies of vendor payment–related documentsGenerate baseline copies of vendor payment–related documents

F IEL DF IEL D EXA M P L E VA L UEEXA M P L E VA L UE

Vendor name GB_SI_000001

Debit 1,000.00

Currency GBP

Offset account type Bank

Offset account GBSI OPER

Method of payment Electronic

c. Select L inesLines , and enter a line that has the following information.

1. Go to Organization administration > Electronic repor ting > Electronic repor ting parametersOrganization administration > Electronic repor ting > Electronic repor ting parameters .

2. On the AttachmentsAttachments  tab, in the BaselineBaseline field, select FileFile as the document type that the Document

management (DM) framework uses to keep documents that are related to the baseline feature as DM

attachments.

1. Go to Accounts payable > Payments > Payment journalAccounts payable > Payments > Payment journal .



Turn on the ER baseline featureTurn on the ER baseline feature

Configure ER baselines for vendor payment processingConfigure ER baselines for vendor payment processing

2. Select L inesLines .

3. Select Generate paymentsGenerate payments .

4. Select the ElectronicElectronic method of payment.

5. Select the GBSI OPERGBSI OPER  bank account.

6. Set the Pr int control repor tPr int control repor t option to YesYes .

7. Download the generated output as a zip file.

8. Open the downloaded file.

9. Extract following files from the downloaded file:

FileFile payment file in text format

ERVendOutPaymControlRepor tERVendOutPaymControlRepor t control report file in XLSX format

1. Go to Organization administration > Electronic repor ting > ConfigurationsOrganization administration > Electronic repor ting > Configurations .

2. On the Action Pane, on the ConfigurationsConfigurations  tab, select User parametersUser parameters .

3. Set the Run in debug modeRun in debug mode option to YesYes .

By turning on the Run in debug modeRun in debug mode parameter, you force the ER framework to perform the following

actions after the execution of any ER format that generates outgoing documents:

1. Determine whether a baseline was configured for any of components of the executed ER format.

2. Determine whether each configured baseline is applicable in the current conditions (company code of the

signed-in company, file name and file name extension of the generated output, and so on).

3. For each applicable baseline, perform the following actions:

a. Compare the output that is generated during execution of the ER format with the corresponding

baseline.

b. Store the results of the comparison in the ER configurations debug log.

1. Go to Organization administration > Electronic repor ting > ConfigurationsOrganization administration > Electronic repor ting > Configurations .

2. Select BaselinesBaselines .

3. Select NewNew .

4. In the ReferenceReference field, select the BACS (UK)BACS (UK)  format.

5. Select AttachmentsAttachments .

6. Add a new baseline for the vendor payment file:



a. Select NewNew .

b. In the TypeType field, select the FileFile DM document type that you configured in the ER parameters to store

baseline artifacts.

c. Browse to select the locally saved FileFile payment file in text format.

d. In the Descr iptionDescr iption field, enter Payment TXT filePayment TXT file.

7. Add a new baseline for the control report for the vendor payment:

a. Select NewNew .

b. In the TypeType field, select the FileFile DM document type that you configured in the ER parameters to store

baseline artifacts.

c. Browse to select the locally saved ERVendOutPaymControlRepor tERVendOutPaymControlRepor t control report file in XLSX

format.

d. In the Descr iptionDescr iption field, enter Payment XLSX control repor tPayment XLSX control repor t.

8. Close the page.

9. On the BaselinesBaselines  FastTab, select NewNew  to configure a baseline for the payment file:

a. Name the line Baseline setting for payment fileBaseline setting for payment file.

b. In the File component nameFile component name field, select filefile to apply this baseline to the ER format output that

generates the payment file in BACS (UK) text format.

c. In the CompaniesCompanies  field, select GBSIGBSI to apply this baseline when the BACS (UK)BACS (UK)  ER format is run in

the GBSI company.

d. In File name maskFile name mask field, enter * .TXT*.TXT to apply this baseline only to outputs of the filefile format

component that have the .txt.txt file name extension.

e. In the BaselineBaseline field, select Payment TXT filePayment TXT file so that this baseline is used for comparison with the

generated output.

10. Select NewNew  to configure a baseline for the control report:

a. Name the line Baseline setting for control repor tBaseline setting for control repor t.

b. In the File component nameFile component name field, select ERVendOutPaymControlRepor tERVendOutPaymControlRepor t to apply this baseline to

the ER format output that generates the control report.

c. In the CompaniesCompanies  field, select GBSIGBSI to apply this baseline when the BACS (UK)BACS (UK)  ER format is run in

the GBSI company.

d. In File name maskFile name mask field, enter * .XLSX*.XLSX to apply this baseline only to outputs of the

ERVendOutPaymControlRepor tERVendOutPaymControlRepor t format component that have the .xslx.xslx file name extension.

e. In the BaselineBaseline field, select Payment XLSX control repor tPayment XLSX control repor t so that this baseline is used for

comparison with the generated output.



Record tests to validate vendor payment processing

Reset user settingsReset user settings

Record the steps to prepare data for testingRecord the steps to prepare data for testing

As a functional power user, you can record your own steps to test vendor payment processing. We recommend

that you play (and edit, as required) the Prepare\Recording.xmlPrepare\Recording.xml  task recording that you downloaded earlier.

This recording is used to set all testing data to the correct state. That step is required because the testing can be

done many times, and every test must use data that is in the same state.

1. Open the default dashboard.

2. Select the SettingsSettings  button (the gear symbol).

3. Select User optionsUser options .

4. Select Usage dataUsage data.

5. Select ResetReset.

6. Select YesYes  to confirm that you want to reset usage data.

7. Close the page.

1. Select the SettingsSettings  button (the gear symbol).

2. Select Task recorderTask recorder .

3. Select Playback recordingPlayback recording.

4. Select Open from this PCOpen from this PC .

5. Select BrowseBrowse, and select the locally save Prepare\Recording.xmlPrepare\Recording.xml  file.

6. Select Star tStar t.

7. Keep selecting Play next pending stepPlay next pending step until all the steps in the recording have been played.

This task recording performs the following actions:

1. Set the status of the processed payment line to NoneNone.



2. Turn on the Run in debug modeRun in debug mode ER user parameter.

3. Clean up the ER debug log that contains the results of the comparison of generated files to baselines.



Record the steps to test vendor payment processingRecord the steps to test vendor payment processing
We recommend that you play (and edit, as required) the Process\Recording.xmlProcess\Recording.xml  task recording that you

downloaded earlier. This recording is used to process vendor payments and validate the results of the

comparison of generated documents to corresponding baselines.

1. Select the SettingsSettings  button (the gear symbol).

2. Select Task recorderTask recorder .

3. Select Playback recordingPlayback recording.

4. Select Open from this PCOpen from this PC .

5. Select BrowseBrowse, and select the locally saved Process\Recording.xmlProcess\Recording.xml  file.

6. Select Star tStar t.

7. Keep selecting Play next pending stepPlay next pending step until all the steps in the recording have been played.

This task recording performs the following actions:

1. Start vendor payment processing.

2. Select the correct runtime parameters, and turn on generation of a control report.

3. Access the ER debug log to record the results of the comparison of generated outputs to corresponding

baselines.

In the ER debug log, the results of the comparison appear in the Generated textGenerated text field. The FormatFormat

componentcomponent and Format path that caused a log entr yFormat path that caused a log entr y  fields refer to the file component for which

the generated output has been compared to the baseline.

4. The comparison of the current output to the baseline is recorded by using the ValidateValidate Task recorder

option and selecting Current ValueCurrent Value.



Add the recorded tests to Azure DevOps

The following illustration shows what the recorded validation steps look like in the task recording.

1. Open the Azure DevOps environment.

2. Select the project that you defined in the RSAT parameters when you configured the tool.

3. Select the test plan that you defined in the RSAT parameters when you configured the tool.

4. Create a new test case for the selected test plan:

a. Name the test case Prepare data to test processing of vendor's electronic paymentPrepare data to test processing of vendor's electronic payment.

b. Attach the Recording.xmlRecording.xml  file from the PreparePrepare folder that you downloaded earlier.

5. Create a new test case for the selected test plan:

a. Name the test case Test processing of vendor payments by using ER format BACS (UK)Test processing of vendor payments by using ER format BACS (UK) .

b. Attach the Recording.xmlRecording.xml  file from the ProcessProcess  folder that you downloaded earlier.



NOTENOTE

Prepare RSAT to run the recorded tests
Load the tests from Azure DevOps to RSATLoad the tests from Azure DevOps to RSAT

Create automation and parameters filesCreate automation and parameters files

Modify the parameters filesModify the parameters files

Pay attention to the correct execution order of the tests that are added.

1. Open the local RSAT application in the current topology.

2. Select LoadLoad to load the tests that currently reside in Azure DevOps into RSAT.

1. In RSAT, select the tests that you loaded from Azure DevOps.

2. Select NewNew  to create RSAT automation and parameters files.

1. In RSAT, select the Prepare data to test processing of vendor's electronic paymentPrepare data to test processing of vendor's electronic payment test case.

2. Select EditEdit.

3. In the Microsoft Excel workbook that is opened, on the GeneralGeneral  worksheet, change the company code to

GBSIGBSI, because this company will be used for test execution.



Run the tests and analyze the results
Run the tests in RSATRun the tests in RSAT

Analyze the results of test executionAnalyze the results of test execution

Simulate a situation where tests failSimulate a situation where tests fail

4. In RSAT, select the Test processing of vendor payments by using ER format BACS (UK)Test processing of vendor payments by using ER format BACS (UK)  test case.

5. Select EditEdit.

6. In the Excel workbook that is opened, on the GeneralGeneral  worksheet, change the company code to GBSIGBSI.

7. On the ERFormatMappingRunLogTableERFormatMappingRunLogTable worksheet, notice that cells A:3 and C:3 contain the text of the

fields in the ER debug log table that are used to validate the results of the comparison of the output to the

baseline. These texts will be used to evaluate ER debug log records that are created during test execution.

1. In RSAT, select the loaded tests.

2. Select RunRun.

Notice that test cases are automatically run in the application by using a web browser.

The results of the test execution are stored in RSAT. Notice that both tests were passed.

Notice that the results of the test execution are also sent to Azure DevOps so that you can do further analysis.

This test suite must fail when at least one of the generated outputs doesn't match the corresponding baseline. To



Run the tests in RSATRun the tests in RSAT

Analyze the results of test executionAnalyze the results of test execution

achieve this situation, you can use your derived version of the BACS (UK)BACS (UK)  format that will generate a payment

file that has different content than the corresponding baseline. To simulate this situation, you can use the same

BACS (UK)BACS (UK)  format but change the payment amount on the processed payment line.

1. Open the application and go to Accounts payable > Payments > Payment journalAccounts payable > Payments > Payment journal .

2. Select L inesLines .

3. Select the payment line, and then select Payment status > NonePayment status > None.

4. In the DebitDebit field, change the value from 1,000.001,000.00  to 2,000.002,000.00 .

5. Select SaveSave to save your changes.

1. In RSAT, select the loaded tests.

2. Select RunRun.

Notice that test cases are automatically run in the application by using a web browser.

The results of the test execution are stored in RSAT. Notice that the second test failed during the second

execution.

Notice that the results of the test execution are also sent to Azure DevOps so that you can do further analysis.

You can access the status of each test. You can also access the execution log so that you analyze the reasons for

any failure. In the following illustration, the execution log shows that the failure occurred because of the

difference in content between the generated payment file and its baseline.



Additional resources

NOTENOTE

Therefore, as you've seen, the functioning of any ER format can be evaluated automatically by using RSAT as the

testing platform and by using Task recorder-based test cases that use the ER baseline feature.

Task recorder resources

Regression suite automation tool

Create and automate user acceptance tests

Deploy and use an environment that supports continuous build and test automation

Trace generated report results and compare them with baseline values

ER Upgrade your format by adopting a new, base version of that format

ER Import a configuration from Lifecycle Services

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://www.microsoft.com/download/details.aspx?id=57357
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/perf-test/continuous-build-test-automation
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Configure Electronic reporting (ER) to pull data into
Power BI
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Overview

Prerequisites

Configure document management parameters

This topic explains how you can use your Electronic reporting (ER) configuration to arrange the transfer of data

from your instance to Power BI services. As an example, this topic uses Intrastat transactions as business data

that must be transferred. The Power BI map visualization uses this Intrastat transaction data to present a view for

analysis of company import/export activities on the Power BI report.

Microsoft Power BI is a collection of software services, apps, and connectors that work together to turn external

sources of data into coherent, visually immersive, and interactive insights. Electronic reporting (ER) lets users

easily configure data sources and arrange the transfer of data from the application to Power BI. The data is

transferred as files in the OpenXML worksheet (Microsoft Excel workbook file) format. The transferred files are

stored on a Microsoft SharePoint Server that has been configured for that purpose. The stored files are used in

Power BI to make reports that include visualizations (tables, charts, maps, and so on). Power BI reports are

shared with Power BI users, and they are accessed in Power BI dashboards and on the application pages. This

topic explains the following tasks:

Configure Microsoft Dynamics 365 Finance.

Prepare your ER format configuration to get data from the Finance application.

Configure the ER environment to transfer data to Power BI.

Use transferred data to create a Power BI report.

Make the Power BI report accessible in Finance.

To complete the example in this topic, you must have the following access:

Access for one of the following roles:

Electronic reporting developer

Electronic reporting functional consultant

System administrator

Access to the SharePoint Server that is configured for use with the application

Access to the Power BI framework

1. On the Document management parametersDocument management parameters  page, configure access to the SharePoint Server that will

be used in the company that you're signed in to (the DEMF company in this example).

2. Test the connection to the SharePoint Server to make sure that you've been granted access.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/general-electronic-reporting-report-configuration-get-data-powerbi.md


Configure ER parameters

Use an ER data model as the source of data

3. Open the configured SharePoint site. Create a new folder where ER will store Excel files that have the

business data that the Power BI reports require as a source of Power BI datasets.

4. On the Document typesDocument types  page, create a new document type that will be used to access the SharePoint

folder that you just created. Enter FileFile in the GroupGroup field and SharePointSharePoint in the LocationLocation field, and then

enter the address of the SharePoint folder.

1. In the Electronic repor tingElectronic repor ting workspace, click the Electronic repor ting parametersElectronic repor ting parameters  link.

2. On the AttachmentsAttachments  tab, select the FileFile document type for all the fields.

3. In the Electronic repor tingElectronic repor ting workspace, make the required provider active by clicking Set activeSet active. For more

information, play the ER Select ser vice providerER Select ser vice provider  task guide.

You must have an ER data model as the source of business data that will be used on Power BI reports. This data

model is uploaded from the ER configurations repository. For more information, see Download Electronic

reporting configurations from Lifecycle Services, or play the ER Impor t a configuration from LifecycleER Impor t a configuration from Lifecycle

Ser vicesSer vices  task guide. Select IntrastatIntrastat as the data model that will be uploaded from the selected ER

configurations repository. (In this example, version 1 of the model is used.) You can then access the IntrastatIntrastat ER

model configuration on the ConfigurationsConfigurations  page.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ger-power-bi-sharepoint-server-setting.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ger-power-bi-sharepoint-document-type.png


Design an ER format configuration
You must create a new ER format configuration that uses the IntrastatIntrastat data model as the source of business

data. This format configuration must generate output results as electronic documents in OpenXML (Excel file)

format. For more information, play the ER Create a configuration for repor ts in OPENXML formatER Create a configuration for repor ts in OPENXML format task

guide. Name the new configuration Impor t / expor t activitiesImpor t / expor t activities , as shown in the following illustration. Use the

ER data - import and export details Excel file as a template when you design the ER format. (For information

about how to import a format template, play the task guide.)

To modify the Impor t / expor t activitiesImpor t / expor t activities  format configuration, follow these steps.

1. Click DesignerDesigner .

2. On the FormatFormat tab, name the file element for this format Excel output fileExcel output file.

3. On the MappingMapping tab, specify the name of the Excel file that will be generated whenever this format is

run. Configure the related expression to return the value Impor t and expor t detailsImpor t and expor t details  (the .xlsx file name

extension will be added automatically).

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ger-power-bi-data-model.png
https://go.microsoft.com/fwlink/?linkid=845208
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ger-power-bi-format-configuration.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ger-power-bi-format-configuration-file-element-name.png


4. Add a new data source item for this format. (This enumeration will be required for further data binding.)

a. Name the data source direction_enumdirection_enum.

b. Select Data model enumerationData model enumeration as the data source type.

c. Refer to the DirectionDirection data model enumeration.

5. Complete the binding of elements of the IntrastatIntrastat data model and elements of the designed format, as

shown in the following illustration.

After it's run, the ER format generates the output result in Excel format. It sends the details of the Intrastat

transactions to the output result, and separates them as transactions that describe either import activities or

export activities. Click RunRun to test the new ER format for the list of Intrastat transactions on the IntrastatIntrastat page

(TaxTax > DeclarationsDeclarations  > Foreign tradeForeign trade > IntrastatIntrastat).
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Configure the ER destination

Schedule execution of the configured ER format

The following output result is generated. The file is named Impor t and expor t details .xlsxImpor t and expor t details .xlsx, as you specified in

the format settings.

You must configure the ER framework to send the output result of the new ER format configuration in a special

way.

The output result must be sent to the folder of the selected SharePoint Server.

Each execution of the format configuration must create a new version of same Excel file.

On the Electronic repor tingElectronic repor ting page (Organization administrationOrganization administration > Electronic repor tingElectronic repor ting), click the

Electronic repor ting destinationElectronic repor ting destination item, and add a new destination. In the ReferenceReference field, select the Impor tImpor t

/ expor t activities/ expor t activities  format configuration that you created earlier. Follow these steps to add a new file

destination record for the reference.

1. In the NameName field, enter the title of the file destination.

2. In the File nameFile name field, select the name Excel output fileExcel output file for the Excel file format component.

Click the SettingsSettings  button for the new destination record. Then, in the Destination settingsDestination settings  dialog box, follow

these steps.

1. On the Power BIPower BI tab, set the EnabledEnabled option to YesYes .

2. In the SharePointSharePoint field, select the SharedShared document type that you created earlier.

1. On the ConfigurationsConfigurations  page (Organization administrationOrganization administration > Electronic repor tingElectronic repor ting >
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ConfigurationsConfigurations ), in the configurations tree, select the Impor t / expor t activitiesImpor t / expor t activities  configuration that

you created earlier.

2. Change the status of version 1.1 from DraftDraft to CompleteComplete to make this format available for use.

3. Select the completed version of the Impor t / expor t activitiesImpor t / expor t activities  configuration, and then click RunRun. Note

that the configured destination is applied to the output result that is generated in Excel format.

4. Set the Batch processingBatch processing option to YesYes  to run this report in unattended mode.

5. Click RecurrenceRecurrence to schedule the required recurrence of this batch execution. The recurrence defines

how often the updated data will be transferred to Power BI.

6. After it's configured, you can find the ER report execution job on the Batch jobsBatch jobs  page (SystemSystem

administration > Inquir ies > Batch jobsadministration > Inquir ies > Batch jobs ).

7. When this job is run for the first time, the destination creates a new Excel file that has the configured

name in the selected SharePoint folder. Every subsequent time that the job is run, the destination creates

a new version of this Excel file.
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Create a Power BI dataset by using the output result of the ER format
1. Sign in to Power BI, and either open an existing Power BI group (workspace) or create a new group. Either

click AddAdd under FilesFiles  in the Impor t or Connect to DataImpor t or Connect to Data section, or click the plus sign (++) next to

DatasetsDatasets  in the left pane.

2. Select the SharePoint – Team sitesSharePoint – Team sites  option, and then enter the path of SharePoint Server that you're

using ( https://ax7partner.litware.com  in our example).

3. Browse to the /Shared Documents/GER data/PowerBI/Shared Documents/GER data/PowerBI folder, and select the Excel file that you created

as the source of data for the new Power BI dataset.
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Create a Power BI report by using the new dataset

4. Click ConnectConnect, and then click Impor tImpor t. A new dataset is created that is based on the selected Excel file.

The dataset can also be added automatically to the newly created dashboard.

5. Configure the refresh schedule for this dataset to force a periodic update. Periodic updates enable the

consumption of new business data that comes via periodic execution of the ER report through new

versions of the Excel file that are created on the SharePoint Server.

1. Click the Impor t and expor t detailsImpor t and expor t details  Power BI dataset that you created.

2. Configure the visualization. For example, select the Filled mapFilled map visualization, and configure it as follows:

Assign the Countr yOriginCountr yOrigin dataset field to the LocationLocation field of the map visualization.

Assign the AmountAmount dataset field to the Color saturationColor saturation field of the map visualization.

Add the ActivityActivity  and YearYear  dataset fields to the FiltersFilters  fields collection of the map visualization.

3. Save the Power BI report as Impor t and expor t details repor tImpor t and expor t details repor t.
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Access Power BI report in Finance

Note that the map shows the countries/regions that are mentioned in the Excel file (Austria and

Switzerland in this example). These countries/regions are colored to show the proportion of invoiced

amounts for each.

4. Update the list of Intrastat transactions. The export transaction that originated from Italy is added.

5. Wait for the next scheduled execution of the ER report and the next scheduled update of the Power BI

dataset. Then review the Power BI report (select to show import transactions only). The updated map now

shows Italy.

Set up the integration with Power BI. For more information, see Configure Power BI integration for workspaces.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ger-power-bi-added-report.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ger-power-bi-new-run-new-transaction.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/analytics/media/ger-power-bi-new-run-new-map.png


Additional resources
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1. On the Electronic repor tingElectronic repor ting workspace page that supports Power BI integration (OrganizationOrganization

administrationadministration > WorkspacesWorkspaces  > Electronic repor ting workspaceElectronic repor ting workspace), click OptionsOptions  > Open repor tOpen repor t

catalogcatalog.

2. Select the Impor t and expor t detailsImpor t and expor t details  Power BI report that you created, to show that report as an action

item on the selected page.

3. Click the action item to open the page that shows the report that you designed in Power BI.

Electronic reporting (ER) destinations

Electronic reporting (ER) overview

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Generate printable FTI forms
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Overview

NOTENOTE

Create customized configurations for FTI printable forms

Configure the ER data modelConfigure the ER data model

Configure the ER model mappingConfigure the ER model mapping

The Electronic reporting (ER) framework lets you generate printable free text invoice (FTI) forms as Microsoft

Office documents. This topic provides information about how to build your own configurations as well as details

of available configuration templates.

In addition to the existing capability of generating printable FTI forms by using Microsoft SQL Server Reporting

Services (SSRS), you can now use the ER framework. You can manage printable FTI forms in Microsoft Office

Excel and Word. You can also modify the layout, data flow, and formatting to meet specific requirements without

making code changes.

If you want to start with an overview of existing ER configurations for this sample of the printable FTI forms solution, you

can go directly to section Download sample ER configurations to generate printable FTI formsDownload sample ER configurations to generate printable FTI forms later in this topic.

As part of your customized solution for printable FTI forms, you must create a set of ER configurations.

Your application must include the ER data model configuration that contains a data model that describes the

customer invoicing business domain. As a requirement, the name of the data model must be

CustomersInvoicingCustomersInvoicing. For information about how to design ER data models, see ER Design domain specific

data model.

Your application must include the ER model mapping for the CustomersInvoicing data model. The model

mapping can be in either the ER data model configuration or the ER model mapping configuration. However, the

name of the root descriptor of the model mapping must be FreeTextInvoiceFreeTextInvoice.

The mapping must contain the following data sources:

Data source type: Table recordsTable records

This data source must be named CustInvoiceJourCustInvoiceJour .

It must refer to the CustInvoiceJour application table.

It's used at runtime to pass from the application to the ER model mapping the list of invoices that have

been selected for printing.

Data source type: ObjectObject

This data source must be named PrintMgmtPrintSettingDetailPr intMgmtPrintSettingDetail .

It must refer to the Pr intMgmtPrintSettingDetailPr intMgmtPrintSettingDetail  application class.

It's used at runtime to pass from the application to the ER model mapping details of the print

management settings for the ER format that is running.

The details of the application integration with the ER framework can be found in the

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-generate-printable-fti-forms.md


Configure the ER formatConfigure the ER format
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Configure print management
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ERPrintMgmtRepor tFormatSubscr iberERPrintMgmtRepor tFormatSubscr iber  class (ER Application Suite integration model) in the source code of

the application.

For more information about the design of ER model mappings, see Define ER model mappings and select data

sources for them.

In your application instance, you must have the ER format configuration that will be used to generate FTI forms.

This format configuration must be created for the CustomersInvoicing data model, and it must use the model mapping

that has the FreeTextInvoiceFreeTextInvoice root descriptor.

For information about how to configure ER formats, see ER Create a format configuration (November 2016). For

information about how to design ER formats to generate reports in OpenXML format, see ER Design a

configuration for generating reports in OPENXML format (November 2016).

To generate FTI forms by using the ER framework, you can assign ER formats in the same way that you assign

SSRS reports. To associate the ER format with all Accounts receivable FTIs, go to Accounts receivableAccounts receivable > SetupSetup

> FormsForms > Form setupForm setup > GeneralGeneral  > Pr int managementPrint management > Free text invoiceFree text invoice > OriginalOriginal . To associate the

ER format with a specific customer or invoice, follow these steps.

1. Go to Accounts receivableAccounts receivable > InvoicesInvoices  > All free text invoicesAll free text invoices .

2. Select the FTI to associate the ER format with, and open the Pr int management setupPrint management setup page.

3. Select the document level to specify the scope of invoices for processing.

4. Select the ER format for the specified document level.

Only ER formats that use the FreeTextInvoiceFreeTextInvoice root descriptor of the CustomersInvoicingCustomersInvoicing data model appear in the

Repor t format lookupRepor t format lookup field for the selected format.



Generate FTI forms
FTI forms are generated in the ER framework in the same way that SSRS reports are generated.

To generate FTI forms, you can select invoices either by range or by selection.
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When you use ER formats to print FTI forms in this way, the default ER file destinations are used. You can't

change the destination. For more information about how to configure the ER destinations for ER formats, see

Electronic reporting (ER) destinations.

You can also generate FTI forms when you post an FTI, by turning Pr int invoicePrint invoice on and turning Use pr intUse pr int

management destinationsmanagement destinations  off.

When you use ER formats to print FTI forms in this way, the default ER file destinations are used. You can change the

default destination at runtime if the destination has already been configured. To change the destination, you must have

the following security privilege:

Name:Name: ERFormatDestinationRuntimeMaintain

Label:Label:  Maintain electronic reporting format destination during runtime

The ER framework currently supports the following destinations for generated documents:

Downloaded fileDownloaded file – Generated forms are offered as downloads that you can save by using the browser.

ScreenScreen – Microsoft 365 Excel is used to preview generated FTI forms in Excel format.

SharePoint folderSharePoint folder  – Generated forms are stored based on the settings of the Document management

framework.

Application archiveApplication archive – Generated forms are stored as attachments of execution log records in the Microsoft

Azure Storage.

EmailEmail  – Generated forms are sent as email attachments.

You can't send the FTI forms that are generated directly to the printer, because direct printing that uses the Dynamics

Printer Routing Agent isn't currently supported.



Download sample ER configurations to generate printable FTI forms
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Features that are implemented in the sample ER formatFeatures that are implemented in the sample ER format

You can download sample ER configurations to use as a template for your FTI solution. The configurations are

stored in the Shared asset library in Microsoft Dynamics Lifecycle Services (LCS). The configurations include:

The Customer invoicing modelCustomer invoicing model  configuration contains the required data model and model mapping.

The Customer FTI repor t (GER)Customer FTI repor t (GER)  configuration contains the sample format.

These configurations have been created as samples to help clarify possible scenarios. The future of these configurations

depends on the results of this evaluation and any feedback that is received.

In the sample ER format configuration, an Excel file is used as a template to generate FTI forms.

Currently, this sample ER format supports the following features to generate FTI forms:

FTI forms are generated for both original invoices that have been posted and original invoices that haven't

yet been posted. Corrected invoices and credit notes aren't supported.

FTI forms are generated in the invoice language. The format of values and dates in the generated forms is

based on the settings of the user's client locale.

Generated invoices show data unavailability notifications if there are no lines in the invoices that are

processed.

Generated invoice headers are based on the paper format that has been selected for the FTI form on the

Accounts receivable parametersAccounts receivable parameters  page. Company details appear in the header of the generated invoice

form only if the paper format is blank.

Generated invoice forms show company and customer tax exempt numbers when the appropriate option has

been selected for the FTI form on the Accounts receivable parametersAccounts receivable parameters  page.

The generated invoice lines and invoice totals sections show the default invoice's monetary details in the

invoice registration currency.

The generated invoice totals section can show monetary details in the euro currency and the invoice

registration currency when the Pr int amount in currency representing the euroPrint amount in currency representing the euro option is enabled on

the Accounts receivable parametersAccounts receivable parameters  page.

Generated invoice forms show any process invoice notes that are available, based on settings on the

Accounts receivable parametersAccounts receivable parameters  page. Notes are included for both the whole invoice and each invoice



Country/region-specific featuresCountry/region-specific features

NorwayNorway

SpainSpain

ItalyItaly

FinlandFinland

line.

Generated invoice forms include notes for the customer FTI form and the processing invoice language when

they have been configured in the AR form notes list.

Depending on the Print management settings, generated invoices include custom footer text when it has

been configured for the invoice language, the ER format, and the FTI document scope.

The totals section of generated invoice forms includes any cash discount information that is available.

The payment schedule section of generated invoice forms includes any payment schedule details that are

available.

The markup section of generated invoice forms includes any charges transactions that are available.

Generated invoice forms include sales tax details, based on the Sales tax specificationSales tax specification setting on the

Accounts receivable parametersAccounts receivable parameters  page. This section can show tax details either in the invoice registration

currency only, or in the invoice registration currency and the company accounting currency at the same time.

Generated invoice forms show direct debit notification details. For example, they show when the method of

payment that has the mandatory direct debit mandate ID was selected for the invoice, when the processing

invoice was registered in the euro currency, and when the direct debit mandate ID was defined for the

invoice.

Generated invoices show any prepayment details that are available for posted invoices.

Generated invoice forms can be sent to an invoice customer as an email attachment. The appropriate ER file

destination should be configured for the ER format that is being used.

The following country/region-specific features are included in the sample ER format to show how specific

requirements can be handled in ER configurations.

The Enterprise register term is put on the header of the generated invoice form when the invoice is processed

for a legal entity that is configured in the following manner :

The country/region context for Norway is used.

The Pr int ForetaksregisteretPr int Foretaksregisteret parameter is active on sales documents.

The Special regime for cash accounting methodSpecial regime for cash accounting method term is put on the header of the generated invoice form

when the invoice is processed for a legal entity that is configured in the following manner :

The country/region context for Spain is used.

The special regime for the cash accounting method is enabled on the invoice processing date.

When cash discount details, such as the cash discount amount and invoice line net amount, are available, they

are presented in the invoice totals section of the generated invoice form when it has been processed for a legal

entity that is configured in the following manner :

The country/region context for Spain is used.

Cash discount is applied in the invoiceCash discount is applied in the invoice is turned on in the invoice option (General ledger parametersGeneral ledger parameters

> Sales tax sectionSales tax section).

The goods discount mark is included on the invoice lines of the generated invoice when it's being processed for

a legal entity that is configured using the country/region context for Italy.

In addition to the generated invoice form, Giro money transfer slips can be generated as follows:

For the legal entity that uses the country/region context for Finland, and that has at least one bank account

that is marked as Giro accountGiro account and Bank bar codeBank bar code.
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Use the sample ER format to configure email destinationsUse the sample ER format to configure email destinations

For an invoice that is marked as required for the FinnishFinnish associated payment attachment.

The sample ER format has been configured to optionally generate the Giro money transfer slips in the separate

worksheet.

You must first install the font that is used to generate the bar code on the local machine where the generated invoice

form in Excel format will be previewed.

Use the following elements of the sample ER format to configure email destinations:

The email address of a customer contact can be accessed through the following ER expression:

model.InvoiceBase.Contact.ElectronicMailmodel.InvoiceBase.Contact.ElectronicMail .

The email subject text can be accessed through the following ER expression: Emailing.TxtToUse.SubjectEmailing.TxtToUse.Subject.

The email body text can be accessed through the following ER expression: Emailing.TxtToUse.BodyEmailing.TxtToUse.Body .



NOTENOTE

The default text of the email's subject and body is defined in the sample ER format. The language depends on

the format's labels. This default text will be used for emails if a custom organization email template that has the

predefined ERFTITMPERFTITMP ID hasn't been added.

The ERFTITMPERFTITMP email template ID has been defined in the sample ER format. It can be changed as required in a new ER

format that is created from this sample format.

If the organization email template that has the predefined ERFTITMPERFTITMP ID has been added for the legal entity that

you're processing the invoice for, the template for the email subject and body text will be used to generate the

email.



Additional resources

The Emailing.TxtToUse.SubjectEmailing.TxtToUse.Subject ER expression of the sample ER format is configured to replace any

occurrences of the placeholder %1 by the processing invoice ID.

The Emailing.TxtToUse.BodyEmailing.TxtToUse.Body  expression of the sample format is configured for the following substitutions for

placeholders:

"%1" is replaced with the name of the customer's contact person.

"%2" is replaced with the company name.

"%3" is replaced with the customer name.

"%4" is replaced with the name of the company's contact person.

"%5" is replaced with the job title of the company's contact person.

"%6" is replaced with the email address of the company's contact person.
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Electronic reporting (ER) overview

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Prerequisites

F IL EF IL E C O N T EN TC O N T EN T

Performance trace model.version.1 Sample ER data model configuration

Performance trace metadata.version.1 Sample ER metadata configuration

Performance trace mapping.version.1.1 Sample ER model mapping configuration

Performance trace format.version.1.1 Sample ER format configuration

Configure ER parametersConfigure ER parameters

As part of the process of designing Electronic reporting (ER) configurations to generate electronic documents,

you define the method that is used to get data out of the application and enter it in the output that is generated.

The ER performance trace feature helps significantly reduce the time and cost that are involved in collecting the

details of ER format execution and using them to troubleshoot performance issues. This tutorial provides

guidelines about how to take performance traces for executed ER formats, and how to use the information from

these traces to help improve performance.

To complete the examples in this tutorial, you must have the following access:

Access to one of the following roles:

Electronic reporting developer

Electronic reporting functional consultant

System administrator

Access to the instance of Regulatory Configuration Services (RCS) that has been provisioned for the same

tenant as the application, for one of the following roles:

Electronic reporting developer

Electronic reporting functional consultant

System administrator

You must also download and locally store the following files.

Each ER performance trace that is generated in the application is stored as an attachment of the execution log

record. The Document management (DM) framework is used to manage these attachments. You must configure

ER parameters in advance, to specify the DM document type that should be used to attach performance traces.

In the Electronic repor tingElectronic repor ting workspace, select Electronic repor ting parametersElectronic repor ting parameters . Then, on the ElectronicElectronic

repor ting parametersrepor ting parameters  page, on the AttachmentsAttachments  tab, in the OthersOthers  field, select the DM document type to

use for performance traces.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/trace-execution-er-troubleshoot-perf.md
https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg
https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg
https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg
https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg
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Configure RCS parametersConfigure RCS parameters

To be available in the OthersOthers  lookup field, a DM document type must be configured in the following manner on

the Document typesDocument types  page (Organization administration > Document management > DocumentOrganization administration > Document management > Document

typestypes ):

Class:Class: Attach file

Group:Group: File

The selected document type must be available in every company of the current instance, because DM attachments are

company-specific.

ER performance traces that are generated will be imported into RCS for analysis by using the ER format

designer and the ER mapping designer. Because ER performance traces are stored as attachments of the

execution log record that is related to the ER format, you must configure RCS parameters in advance, to specify

the DM document type that should be used to attach performance traces. In the instance of RCS that has been

provisioned for your company, in the Electronic repor tingElectronic repor ting workspace, select Electronic repor tingElectronic repor ting

parametersparameters . Then, on the Electronic repor ting parametersElectronic repor ting parameters  page, on the AttachmentsAttachments  tab, in the OthersOthers

field, select the DM document type to use for performance traces.

To be available in the OthersOthers  lookup field, a DM document type must be configured in the following manner on



    

Design an ER solution

Run the ER solution to trace execution

Import an ER configuration from RCS into Finance and OperationsImport an ER configuration from RCS into Finance and Operations

the Document typesDocument types  page (Organization administration > Document management > DocumentOrganization administration > Document management > Document

typestypes ):

Class:Class: Attach file

Group:Group: File

Assume that you've started to design a new ER solution to generate a new report that presents vendor

transactions. Currently, you can find the transactions for a selected vendor on the Vendor transactionsVendor transactions  page

(go to Account payable > Vendors > All vendorsAccount payable > Vendors > All vendors , select a vendor, and then, on the Action Pane, on the

VendorVendor  tab, in the TransactionsTransactions  group, select TransactionsTransactions ). However, you want to have all vendor transaction

at the same time in one electronic document in XML format. This solution will consist of several ER

configurations that contain the required data model, metadata, model mapping, and format components.

1. Sign in to the instance of RCS that has been provisioned for your company.

2. In this tutorial, you will create and modify configurations for the L itware, Inc.L itware, Inc. sample company.

Therefore, make sure that this configuration provider has been added to RCS and selected as active. For

instructions, see the Create configuration providers and mark them as active procedure.

3. In the Electronic repor tingElectronic repor ting workspace, select the Repor ting configurationsRepor ting configurations  tile.

4. On the ConfigurationsConfigurations  page, import the ER configurations that you downloaded as a prerequisite into

RCS, in the following order : data model, metadata, model mapping, format. For each configuration, follow

these steps:

a. On the Action Pane, select Exchange > Load from XML fileExchange > Load from XML file.

b. Select BrowseBrowse to select the appropriate file for the required ER configuration in XML format.

c. Select OKOK.

Assume that you've finished designing the first version of the ER solution. You now want to test it in your

instance and analyze execution performance.

1. Sign in to your application instance.

2. For this tutorial, you will import configurations from your RCS instance (where you design your ER

components) into your instance (where you test and finally use them). Therefore, you must make sure

that all the required artifacts have been prepared. For instructions, see the Import Electronic reporting

https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/analytics/tasks/er-configuration-provider-mark-it-active-2016-11
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/analytics/rcs-download-configurations


Turn on the ER performance traceTurn on the ER performance trace

(ER) configurations from Regulatory Configuration Services (RCS) procedure.

3. Follow these steps to import the configurations from RCS into the application:

a. In the Electronic repor tingElectronic repor ting workspace, on the tile for the L itware, Inc.L itware, Inc. configuration provider, select

Repositor iesRepositor ies .

b. On the Configuration repositor yConfiguration repositor y  page, select the repository of the RCSRCS  type, and then select

OpenOpen.

c. On the ConfigurationsConfigurations  FastTab, select the Performance trace formatPerformance trace format configuration.

d. On the VersionsVersions  FastTab, select version 1.11.1  of the selected configuration, and then select Impor tImpor t.

The corresponding versions of the data model and model mapping configurations are automatically imported

as prerequisites for the imported ER format configuration.

1. Go to Organization administration > Electronic repor ting > ConfigurationsOrganization administration > Electronic repor ting > Configurations .

2. On the ConfigurationsConfigurations  page, on the Action Pane, on the ConfigurationsConfigurations  tab, in the AdvancedAdvanced

settingssettings  group, select User parametersUser parameters .

3. In the User parametersUser parameters  dialog box, in the Execution tracingExecution tracing section, follow these steps:

a. In the Execution trace formatExecution trace format field, select Debug trace formatDebug trace format to start to collect the details of

ER format execution. When this value is selected, the performance trace will collect information

about the time that is spent on the following actions:

Running each data source in the model mapping that is called to get data

Processing each format item to enter data in the output that is generated

You use the Execution trace formatExecution trace format field to specify the format of the generated performance

trace that the execution details are stored in for ER format and mapping elements. By selecting

Debug trace formatDebug trace format as the value, you will be able to analyze the content of the trace in ER

Operation designer, and see the ER format or mapping elements that are mentioned in the trace.

b. Set the following options to YesYes  to collect specific details of the execution of the ER model

mapping and ER format components:

Collect quer y statisticsCollect quer y statistics  – When this option is turned on, the performance trace will

collect the following information:

The number of database calls that were made by data sources

The number of duplicate calls to the database

Details of the SQL statements that were used to make database calls



        

    

Run the ER formatRun the ER format

Review the execution trace
Export the generated trace from the applicationExport the generated trace from the application

NOTENOTE

Trace access of cachingTrace access of caching – When this option is turned on, the performance trace will

collect information about the ER model mapping's cache usage.

Trace data accessTrace data access  – When this option is turned on, the performance trace will collect

information about the number of calls to the database for executed data sources of the

record list type.

Trace list enumerationTrace list enumeration – When this option is turned on, the performance trace will collect

information about the number of records that are requested from data sources of the

record list type.

The parameters in the User parametersUser parameters  dialog box are specific to the user and the current company.

1. Select the DEMFDEMF company.

2. Go to Organization administration > Electronic repor ting > ConfigurationsOrganization administration > Electronic repor ting > Configurations .

3. On the ConfigurationsConfigurations  page, in the configuration tree, select the Performance trace formatPerformance trace format item.

4. On the Action Pane, select RunRun.

Notice that the file that is generated presents information about 265 transactions for six vendors.

Performance traces are decoupled from the source ER format and can be serialized to an external zip file.

1. Go to Organization administration > Electronic repor ting > Configuration debug logsOrganization administration > Electronic repor ting > Configuration debug logs .

2. On the Electronic repor ting run logsElectronic repor ting run logs  page, in the left pane, in the Configuration nameConfiguration name field, select

Performance trace formatPerformance trace format to find the log records that have been generated by the execution of the

Performance trace formatPerformance trace format configuration.

3. Select the AttachmentsAttachments  button (the paper clip symbol) in the upper-right corner of the page, or press

Ctr l+Shift+ACtr l+Shift+A.
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Import the generated trace into RCSImport the generated trace into RCS

4. On the Attachments for Electronic repor ting run logsAttachments for Electronic repor ting run logs  page, on the Action Pane, select OpenOpen to get

the performance trace as a zip file and store it locally.

The trace that is generated has a reference to the source ER report via a unique report identifier in GUIDGUID format only. The

version numbering of the format isn't considered.

Notice that the association between the performance trace that has been generated for the executed ER format

and the ER model mapping is based on the root descriptor that was used and the common data model. The

version numbering of the format and model mapping isn't considered. The setting of the Default for modelDefault for model

mappingmapping flag for the model mapping also isn't considered.

1. In RCS, in the Electronic repor tingElectronic repor ting workspace, select the Repor ting configurationsRepor ting configurations  tile.

2. On the ConfigurationsConfigurations  page, in the configuration tree, expand the Performance trace modelPerformance trace model  item,

and select the Performance trace formatPerformance trace format item.

3. On the Action Pane, select DesignerDesigner .

4. On the Format designerFormat designer  page, on the Action Pane, select Performance tracePerformance trace.

5. In the Performance trace result settingsPerformance trace result settings  dialog box, select Impor t performance traceImpor t performance trace.

6. Select BrowseBrowse to select the zip file that you exported earlier.

7. Select OKOK.



    

Use the performance trace for analysis in RCS – Format executionUse the performance trace for analysis in RCS – Format execution

Use the performance trace for analysis in RCS – Model mappingUse the performance trace for analysis in RCS – Model mapping

1. In RCS, on the Format designerFormat designer  page, select Expand/collapseExpand/collapse to expand the content of all format

items.

Notice that additional information is shown for some items of the current format:

The actual time that was spent entering data in the generated output by using the format item

The same time expressed as a percentage of the total time that was spent generating the whole output

2. Close Format designerFormat designer  page.

1. In RCS, on the ConfigurationsConfigurations  page, in the configuration tree, select the Performance trace mappingPerformance trace mapping

item.

2. On the Action Pane, select DesignerDesigner .

3. Select DesignerDesigner .

4. On the Model mapping designerModel mapping designer  page, on the Action Pane, select Performance tracePerformance trace.

5. Select the trace that you imported earlier.

6. Select OKOK.

Notice that new information becomes available for some data source items of the current model mapping:

The actual time that was spent getting data by using the data source

The same time expressed as a percentage of the total time that was spent running the whole model mapping

Notice that ER informs you that the current model mapping duplicates database requests while the

VendTable/<Relations/VendTrans.VendTable_AccountNum data source is run. This duplication occurs because

the list of vendor transactions is called two times for each iterated vendor record:



One call is made to enter details of each transaction in the data model, based on configured bindings.

One call is made to enter the calculated number of transactions per vendor in the data model.

The value [Q:530][Q:530]  indicates that the VendTrans table was called 530 times to return a record from that table to

the VendTable/<Relations/VendTrans.VendTable_AccountNum data source. The value [530][530]  indicates that the

VendTable/<Relations/VendTrans.VendTable_AccountNum data source was called 530 times to return a record

from that data source and enter the details from it in the data model.

We recommend that you use caching for the VendTable/<Relations/VendTrans.VendTable_AccountNum data

source, to reduce the number of calls that are made to get the details for 265 transactions and help improve the

performance of the model mapping.

It can also be useful to reduce the number of calls that are made to the LedgerTransTypeList data source. This

data source is used to associate each value of the LedgerTransTypeLedgerTransType enumeration with its label. By using this

data source, you can find an appropriate label and enter it in the data model for each vendor transaction. The

current number of calls to this data source (9,027) is quite high for 265 transactions.



Improve the model mapping based on information from the
execution trace
Modify the logic of the model mappingModify the logic of the model mapping
1. Follow these steps to use caching, to help prevent duplicate calls to the database:

a. In RCS, on the Model mapping designerModel mapping designer  page, in the Data sourcesData sources  pane, select the VendTableVendTable

item.

b. Select CacheCache.

c. Expand the VendTableVendTable item, expand the list of one-to-many relations for the VendTable data source

(the <Relations<Relations  item), and select the VendTrans.VendTable_AccountNumVendTrans.VendTable_AccountNum item.

d. Select CacheCache.

2. Follow these steps to bring the LedgerTransTypeList data source into the scope of the VendTable data

source:

a. In the Data source typesData source types  pane, expand the FunctionsFunctions  item, and select the Calculated fieldCalculated field item.

b. In the Data sourcesData sources  pane, select the VendTableVendTable item.

c. Select AddAdd.

d. In the NameName field, enter $TransType$TransType.

e. Select Edit formulaEdit formula.

f. In the FormulaFormula field, enter LedgerTransTypeListLedgerTransTypeList.

g. Select SaveSave.

h. Close the Formula editorFormula editor  page.

i. Click OKOK.

3. Follow these steps to do caching of the $TransType$TransType field:

a. Select the LedgerTransTypeListLedgerTransTypeList item.

b. Select CacheCache.

c. Select the VendTable.$TransTypeVendTable.$TransType item.

d. Select CacheCache.



Complete the modified version of the ER model mappingComplete the modified version of the ER model mapping

Import the modified ER model mapping configuration from RCS into the applicationImport the modified ER model mapping configuration from RCS into the application

Run the modified ER solution to trace execution

4. Follow these steps to change the $TransTypeRecord$TransTypeRecord field so that it starts to use the cached $TransType$TransType

field:

a. In the Data sourcesData sources  pane, expand the VendTableVendTable item, expand the <Relations<Relations  item, expand the

VendTrans.VendTable_AccountNumVendTrans.VendTable_AccountNum item, and select the VendTable.VendTable.

VendTrans.VendTable_AccountNum.$TransTypeRecordVendTrans.VendTable_AccountNum.$TransTypeRecord item.

b. Select EditEdit.

c. Select Edit formulaEdit formula.

d. In the FormulaFormula field, find the following expression:

FIRSTORNULL (WHERE (LedgerTransTypeList, LedgerTransTypeList.Enum = @.TransType))

e. In the FormulaFormula field, enter the following expression:

FIRSTORNULL (WHERE (VendTable.'$TransType', VendTable.'$TransType'.Enum = @.TransType)).

f. Select SaveSave.

g. Close the Formula editorFormula editor  page.

h. Select OKOK.

5. Select SaveSave.

6. Close the Model mapping designerModel mapping designer  page.

7. Close the Model mappingsModel mappings  page.

1. In RCS, on the ConfigurationsConfigurations  page, on the VersionsVersions  FastTab, select version 1.21.2  of the Performance tracePerformance trace

mappingmapping configuration.

2. Select Change statusChange status .

3. Select CompleteComplete.

Repeat the steps in the Import an ER configuration from RCS into Finance and Operations section earlier in this

topic to import version 1.2 of the Performance trace mappingPerformance trace mapping configuration.



Run the ER formatRun the ER format

Work with the execution trace
Export the generated trace from the applicationExport the generated trace from the application

Import the generated trace into RCSImport the generated trace into RCS

Use the performance trace for analysis in RCS – Model mappingUse the performance trace for analysis in RCS – Model mapping

Repeat the steps in the Run the ER format section earlier in this topic to generate a new performance trace.

Repeat the steps in the Export the generated trace from the application section earlier in this topic to save a new

performance trace locally.

Repeat the steps in the Import the generated trace into RCS section earlier in this topic to import the new

performance trace into RCS.

Repeat the steps in the Use the performance trace for analysis in RCS – Model mapping section earlier in this

topic to analyze the latest performance trace.

Notice that the adjustments that you made to the model mapping have eliminated duplicate queries to

database. The number of calls to database tables and data sources for this model mapping has been also

reduced. Therefore, the performance of the whole ER solution has improved.

In the trace information, the value [12][12]  for the VendTable data source indicates that this data source was called

12 times. The value [Q:6][Q:6]  indicates that six calls were translated to database calls to the VendTable table. The

value [C:6][C:6]  indicates that the records that were fetched from the database were cached, and six other calls were

processed by using the cache.

Notice that the number of calls to the LedgerTransTypeList data source has been reduced from 9,027 to 240.



Review the execution trace in the application

Review the execution trace by using external tools
Configure user parametersConfigure user parameters

Run the ER formatRun the ER format

In addition to RCS, some versions might offer capabilities for an ER framework designer experience. These

versions have an Enable design modeEnable design mode option that can be turned on. You can find this option on the GeneralGeneral

tab of the Electronic repor ting parametersElectronic repor ting parameters  page, which you can open from the Electronic repor tingElectronic repor ting

workspace.

If you use one of these versions, you can analyze the details of generated performance traces directly in the

application. You don't have to export them from the application and import them into RCS.

1. Go to Organization administration > Electronic repor ting > ConfigurationsOrganization administration > Electronic repor ting > Configurations .

2. On the ConfigurationsConfigurations  page, on the Action Pane, on the ConfigurationsConfigurations  tab, in the Advanced settingsAdvanced settings

group, select User parametersUser parameters .

3. In the User parametersUser parameters  dialog box, in the Execution tracingExecution tracing section, in the Execution trace formatExecution trace format field,

select PerfView XMLPerfView XML .

Repeat the steps in the Run the ER format section earlier in this topic to generate a new performance trace.

Notice that the web browser offers a zip file for download. This file contains the performance trace in PerfView

format. You can then use the PerfView performance analysis tool to analyze the details of ER format execution.



Use external tools to review an execution trace that includes database
queries

Configure user parametersConfigure user parameters

Because of improvements that have been made to the ER framework, the performance trace that is generated in

PerfView format now offers more details about ER format execution. In Microsoft Dynamics 365 for Finance and

Operations version 10.0.4 (July 2019), this trace can also include details of executed SQL queries to the

application database.

1. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > ConfigurationsConfigurations .

2. On the ConfigurationsConfigurations  page, on the Action Pane, on the ConfigurationsConfigurations  tab, in the AdvancedAdvanced

settingssettings  group, select User parametersUser parameters .

3. In the User parametersUser parameters  dialog box, in the Execution tracingExecution tracing section, set the following parameters:

In the Execution trace formatExecution trace format field, select PerfView XMLPerfView XML .

Set the Collect quer y statisticsCollect quer y statistics  option to YesYes .

Set the Trace quer yTrace quer y  option to YesYes .



Run the ER formatRun the ER format

Additional resources

NOTENOTE

Repeat the steps in the Run the ER format section earlier in this topic to generate a new performance trace.

Notice that the web browser offers a zip file for download. This file contains the performance trace in PerfView

format. You can then use the PerfView performance analysis tool to analyze the details of ER format execution.

This trace now includes the details of SQL database access during the execution of the ER format.

Electronic Reporting overview

Improve performance of ER solutions by adding parameterized CALCULATED FIELD data sources

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/er-calculated-field-ds-performance
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Supported deployments

Supported Microsoft Office applications

Business document availability

Business users use the Electronic reporting (ER) framework to configure formats for outbound documents in

accordance with the legal requirements of various countries/regions. Users can also define the dataflow to

specify what application data is placed in generated documents. The ER framework generates outbound

documents in Microsoft Office formats (Excel workbooks or Word documents) by using predefined templates.

The templates are populated with required data in accordance to configured dataflow while required documents

are generated. Each configured format can be published as part of an ER solution to generate specific outbound

documents. This is represented by an ER format configuration that can contain templates you can use to

generate different outbound documents. Business users can use this framework to manage required business

documents.

Business document managementBusiness document management is built on top of the ER framework and enables business users to edit

business document templates by using Microsoft 365 service or appropriate Microsoft Office desktop

application. Edits to the documents might include changing business document designs and adding

placeholders for additional data without source code changes and new deployments. No knowledge of the ER

framework is required to update templates of business documents.

Be aware that Business document management allows you to modify templates that are used to produce business

documents such as orders, invoices, etc. While a template has been modified and a new version of it has been published,

this version is used to generate required business documents. Business document management cannot be used to modify

already generated business documents.

Currently, the Business document management feature is implemented only for cloud deployments. If this

feature is critical to your on-premises deployment, let us know by providing feedback on the Ideas site.

To use Business document management for editing templates in Excel or Word formats by using Microsoft

Office desktop applications, you must have Microsoft Office 2010 or later installed. This is supported in cloud

and on-premises deployments.

To use Business document management for editing templates in Excel or Word formats by using Microsoft 365

applications, you must have Microsoft 365 Office for the web subscription. This is supported in cloud

deployment.

For a complete list of all the reports planned for the October 2019 release, see Configurable business

documents reporting in Word and Excel.

For a complete list of all the reports planned for the October 2020 release, see Configurable business

documents – Word templates.

More reports will become available in future releases. Special notifications about additional reports will be sent

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-business-document-management.md
https://experience.dynamics.com/ideas/
https://docs.microsoft.com/en-us/dynamics365-release-plan/2019wave2/dynamics365-finance-operations/configurable-business-documents-reporting-word-excel-pdf#feature-details
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave1/dynamics365-finance/configurable-business-documents-word-templates


Configure ER parameters

Import ER solutions

F IL EF IL E C O N T EN TC O N T EN T

Customer invoicing model.version.2.xml ER data model configuration

Customer FTI report (GER).version.2.3.xml Free text invoice ER format configuration

F IL EF IL E C O N T EN TC O N T EN T

Model for cheques.version.10.xml ER data model configuration

Cheques printing format.version.10.9.xml Payment cheque ER format configuration

separately. To learn how to review the list of currently available reports, see the section List of ER configurations

that have been released in Finance to support configurable business documents below.

To learn more about this feature, complete the example in this topic.

Because Business document management is built on top of the ER framework, you must configure the ER

parameters to start working with Business document management. To do this, you need to set up the ER

parameters as described in Configure the Electronic reporting (ER) framework. You also need to add a new

configuration provider as described in Create configuration providers and mark them as active.

Sample ER configurations are used in the example of this procedure. You must import, into your current

instance of Dynamics 365 Finance, the ER configurations that contain the business document templates that can

be edited by using Business document management. Download, and then locally store the following files to

complete this procedure.

Sample ER customer invoicing solutionSample ER customer invoicing solution

Sample ER payment checks solutionSample ER payment checks solution

Sample ER foreign trade solutionSample ER foreign trade solution

https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg
https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg
https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg
https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg


F IL EF IL E C O N T EN TC O N T EN T

Intrastat model.version.1.xml ER data model configuration

Intrastat report.version.1.9.xml Intrastat control report ER format configuration

Use the following procedure to import each file. Import the ER data model configuration of each ER solution in

the tables above before you import the corresponding ER format configuration.

1. Open the Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > ConfigurationsConfigurations  page.

2. On the top of the page, select ExchangeExchange.

3. Select Load from XML fileLoad from XML file.

4. Select BrowseBrowse to load the required XML file.

5. Select OKOK to confirm configuration's import.

Alternatively, you can import the officially published ER format configurations from Microsoft Dynamics

Lifecycle Service (LCS). For example, to complete this procedure you can import the latest version of the FreeFree

text invoice (Excel)text invoice (Excel)  ER format configuration. The corresponding ER data model and ER model mapping

configurations will be imported automatically.

For more information about importing ER configurations, see Manage the ER configuration lifecycle.

https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg
https://mbs.microsoft.com/customersource/Global/AX/downloads/hot-fixes/365optelecrepeg


Enable Business document management
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Configure parameters

Prerequisites for parameter setupPrerequisites for parameter setup
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Class Attach file

To start Business document management, you need to open the Feature managementFeature management workspace and enable

the Business document managementBusiness document management feature.

Use the following procedure to enable Business document management functionality for all legal entities.

1. Open the Feature managementFeature management workspace.

2. On the NewNew  tab, select the Business document managementBusiness document management feature in the list.

3. Select Enable nowEnable now  to turn on the selected feature.

4. Refresh the page to access the new feature.

For more information about using the new document user interface in Business document management, see New

document user interface in Business document management.

For more information about activating new features, see Feature management overview.

Use the information in the following sections to set up the basic parameters for Business document

management.

Before you can set up Business document management, you must set up the required document type in the

Document management framework. This document type is used to specify a temporary storage of documents

in Office formats (Excel and Word) that are used as templates for ER reports. The temporary storage template

can be edited by using the Office desktop applications.

For this document type, the following attribute values must be selected.



Group File

Location SharePoint

AT T RIB UT E N A M EAT T RIB UT E N A M E AT T RIB UT E VA L UEAT T RIB UT E VA L UE

Set up parametersSet up parameters
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For information about how to set up the required document management parameters and document types, see

Configure document management.

Basic Business document management parameters can be set up on the Business document parametersBusiness document parameters

page. Only specific users can access the page. This includes:

Users who are assigned to the System administratorSystem administrator  role.

Users who are assigned to any role that is configured to perform the duty, Maintain Business documentMaintain Business document

management parametersmanagement parameters  (AOT name ERBDMaintainParametersERBDMaintainParameters ).

Use the following procedure to set up the basic parameters for all legal entities.

1. Sign in as a user with access to the Business document parametersBusiness document parameters  page.

2. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > Business document managementBusiness document management >

Business document parametersBusiness document parameters .

3. On the Business document parametersBusiness document parameters  page, on the AttachmentsAttachments  tab, in the SharePoint documentSharePoint document

typetype field, define the document type that should be used to temporarily store templates in Office formats

while they are edited using the Office desktop applications.

Only document types that are configured using a SharePoint location are available for this parameter.



NOTENOTE

Configure access permissions

The selected document type is company-specific and will be used when the user is working with Business

document management in the company for which the selected document type is configured. When the user is

working with Business document management in another company, the same selected document type will be

used if one has not been configured for this company. When a document type has been configured, it will be

used instead of the one selected in the SharePoint document typeSharePoint document type field.

The SharePoint document typeSharePoint document type parameter defines a SharePoint folder as temporary storage for templates that are

editable using either Microsoft Excel or Word. You need to set up this parameter if you plan to use these Office desktop

applications for editing templates. For more information, see Edit a template in the Office desktop application. You can

keep this parameter blank if you plan to modify the template by only using the functionality in Microsoft 365. For more

information, see Edit a template in Microsoft 365.

By default, when access to Business document management permissions is not enabled, every user with access

to the Business document management workspace will see all of the ER solution templates that are available.

The Business document management workspace will show only those templates that reside in ER format

configurations and that are marked by a Business document typeBusiness document type tag.

The list of templates available in the Business document management workspace can be restricted by

configuring access permissions. This may be important when different templates are used to produce business

documents for different business domains (functional areas), and you want to allow specific users access to

different templates for editing in the Business document management workspace.



Business document management access permissions can be set on the Configurator of access permissionsConfigurator of access permissions .

Only the following users can access the page:

Users assigned to the System administratorSystem administrator  role.

Users assigned to any other role that is configured to perform the duty, Configure permissions to accessConfigure permissions to access

Business document templates for editingBusiness document templates for editing (AOT name ERBDTemplatesSecurityERBDTemplatesSecurity ).

Use the following procedure to set up the access Business document management permissions for all legal

entities.

1. Sign in as a user with access to the Configurator of access permissionsConfigurator of access permissions  page.

2. Go to Organization administrationOrganization administration > Electronic repor tingElectronic repor ting > Business document managementBusiness document management

> Manage access permissionsManage access permissions .

Pay attention to the notification informing you that the usage of access permissions for Business

document management is currently not enabled.

With this setting, every user assigned to any security role that is configured to perform the ManageManage

Business document templatesBusiness document templates  (AOT name ERBDManageTemplatesERBDManageTemplates ) duty is able to open the

Business document management workspace and can edit any template that is available.

The following graphic shows what is available in the Business document management workspace for

users assigned to the Accounts receivable clerkAccounts receivable clerk  role. With the current access permissions setting, the

user can edit business document templates from different functional areas including invoicing, regulatory

reporting, and payments.

3. On the Configurator of access permissionsConfigurator of access permissions  page, select Access permissions settingAccess permissions setting.

4. In the Settings of access permissions to edit templatesSettings of access permissions to edit templates  dialog box, enable the Apply configuredApply configured

access permissionsaccess permissions  option.



5. Select OKOK to confirm that Business document management access permissions have been enabled.

6. Select AddAdd to enter a new business role for which permissions to access Business document

management templates must be configured.

7. In the Security rolesSecurity roles  dialog box, select the Accounts receivable clerkAccounts receivable clerk  role and then select OKOK to

confirm the role selection.

8. On the Access permissions per tags of configurationsAccess permissions per tags of configurations  tab, select NewNew .

9. In the Tag typeTag type field, select Functional areaFunctional area, and in the IDID field, select InvoicingInvoicing.

10. Select SaveSave to store configured access permissions for the selected role.

The current setting means that for any user who is assigned to the Accounts receivable clerkAccounts receivable clerk  role and

performing the duty, Manage Business document templatesManage Business document templates  (AOT name ERBDManageTemplatesERBDManageTemplates ),

ER format configuration templates that have the InvoicingInvoicing value for the Functional areaFunctional area tag will be

available to edit in the Business document management workspace.

11. Switch the Related informationRelated information pane from the right side of the current page. The RelatedRelated

informationinformation pane shows how the configured access permissions will be applied, including what ER

configuration templates will be available for users that are assigned to the Accounts receivable clerkAccounts receivable clerk

role.

12. On the Access permissions per configurationsAccess permissions per configurations  tab, select the AddAdd option.

13. In the Select configurationSelect configuration dialog box, mark the Intrastat repor tIntrastat repor t ER format configuration.

14. Select OKOK to confirm the entry of the selected configurations and then select SaveSave to store the

configured access permissions for the selected role.



The current setting means that for any user assigned to the Accounts receivable clerkAccounts receivable clerk  role and performing

the duty, Manage Business document templatesManage Business document templates  (AOT name ERBDManageTemplatesERBDManageTemplates ), the following

templates will be available to edit in the Business document management workspace:

Templates that have the value, InvoicingInvoicing for the Functional areaFunctional area tag.

Templates from ER format configurations that are listed on the Access permissions per configurationsAccess permissions per configurations

tab (templates from the Intrastat repor tIntrastat repor t format configuration of the Statutor y repor tingStatutor y repor ting domain in this

example).

The following graphic shows what the Business document management workspace provides to a user assigned

to the Accounts receivable clerkAccounts receivable clerk  role. With the current Business document management access permissions

setting, the user can edit business document templates from the InvoicingInvoicing domain and the Intrastat repor tIntrastat repor t

ER format configuration. Templates from the PaymentsPayments  domain are not accessible for the AccountsAccounts

receivable clerkreceivable clerk  role.



NOTENOTE

Use Business document management to edit templates

The Access permissions per configurationsAccess permissions per configurations rules are stored by using the unique identification ID of an ER format

configuration. This means that these rules will not be deleted when an ER configuration that refers to them are deleted.

When you import deleted configurations back to this instance, these rules will refer to them again. There is no need to set

up the rules again after the deleted configurations are imported again.

Business users can access business document templates for editing in the Business document management

workspace. Only the following users can access the Business document management workspace:

Users assigned to the role, System administratorSystem administrator .

Users assigned to any role that is configured to perform the duty, Manage Business document templatesManage Business document templates

(AOT name ERBDManageTemplatesERBDManageTemplates ).

Use the following procedure to edit free text invoice templates in the Business document management

workspace. Before you complete this procedure, you must have completed all of the preceding procedures in

this topic.

1. Sign in as a user with access to the Business document management workspace.

2. Open the Business document management workspace.

When the Office-like UI experience for Business document managementOffice-like UI experience for Business document management feature is turned off in the

Feature managementFeature management workspace, the main grid in the Business document managementBusiness document management workspace shows

the following templates:

Templates that are owned by your ER configuration provider (that is, the provider that is currently marked as

active in the Electronic repor tingElectronic repor ting workspace). After you select one of these templates, you can select EditEdit

templatetemplate to start or continue to edit it.

Templates that are owned by other ER configuration providers. After you select one of these templates, you

can select New documentNew document to create a copy of it that is owned by your ER configuration provider, and then

start to edit the copy.

The TemplateTemplate tab presents the content of the selected template. Select the DetailsDetails  tab to review details of the

selected template as well as details of an ER format configuration this template resides in. Notice that all of the

templates have a status of PublishedPublished, and contain no details in the RevisionRevision column. This means that these

templates are not currently being edited.

When the Office-like UI experience for Business document managementOffice-like UI experience for Business document management feature is turned on in the



Initiate editing templates owned by your configuration providerInitiate editing templates owned by your configuration provider

Initiate editing templates owned by other providersInitiate editing templates owned by other providers

Feature managementFeature management workspace, the main grid in the Business document managementBusiness document management workspace shows

templates that are owned by your ER configuration provider (that is, the provider that is currently marked as

active in the Electronic repor tingElectronic repor ting workspace). After you select one of these templates, you can select EditEdit

templatetemplate to start or continue to edit it.

To work with templates that are owned by other ER configuration providers, select New documentNew document to create a

copy of the template that is owned by your ER provider. You can then start to edit the copy. For more

information, see New document user interface in Business document management.

1. In the Business document management workspace, select the Cheques pr inting formatCheques pr inting format template in the

list.

2. Select the DetailsDetails  tab.

The Edit templateEdit template option is available for the selected template. This option is always available for a template in

an ER format configuration that is owned by the active ER configuration provider (L itware, Inc.L itware, Inc. in this

example). When Edit templateEdit template is selected, the existing template from the draft version of the underlying ER

format configuration will be available to edit.

1. In the Business document management workspace, select the document that you want to use as a

template.

2. Select New documentNew document, and in the TitleTitle field, change the title of the editable template if needed. The text

will be used to name the ER format configuration that is automatically created. Note that the draft version

of this configuration (Customer FTI repor t (GER) CopyCustomer FTI repor t (GER) Copy) that will contain the edited template will



Start editing a templateStart editing a template

automatically be marked to run this ER format for the current user. At the same time, the non-modified

original template from the base ER format configuration will be used to run this ER format for any other

user.

3. In the NameName field, change the name of the first revision of the editable template that will be created

automatically.

4. In the CommentComment field, change the comment for the automatically created revision of the editable

template.

5. Select OKOK to confirm the start of the editing process.

The New documentNew document option is always available for a template in an ER format configuration provided by

current and another provider (Microsoft in this example) that doesn't have any revision. The edited template will

then be stored in a new ER format configuration that is automatically generated.

1. From the selected template, select Edit documentEdit document.

2. In the NameName field, change the name of the first revision of the editable template that will be created

automatically.

3. In the CommentComment field, change the remark for the automatically created revision of the editable template.

4. Select OKOK to confirm the start of the editing process.

The BDM template editorBDM template editor  page will open. The selected template will be available for online editing by using



Edit a template in Microsoft 365Edit a template in Microsoft 365

Edit a template in the Office desktop applicationEdit a template in the Office desktop application

NOTENOTE

Microsoft 365.

You can modify the template using Microsoft 365. For example, in Office online, change the font of the field

prompts in the template header from RegularRegular  to BoldBold. These changes are automatically stored in the editable

template that is stored in the primary template's storage (by default, the Azure blob storage). This is configured

for the ER framework.

This function is only available when the SharePoint document typeSharePoint document type parameter is properly configured. For more

information, see Configure parameters.

1. Select the Open in Desktop AppOpen in Desktop App option to modify the template by using the functionality of the Office

desktop application (Excel in this example). The editable template is copied from the permanent storage

to the temporary storage configured in the Business document management parameters as a SharePoint

folder.

2. Confirm that you want to open the template from the temporary file storage in the Office desktop Excel

application.



3. Modify the template. For example, change the font of the fields prompts in the template header by

updating color from BlackBlack to BlueBlue.

4. Select SaveSave in the Excel desktop application to store the template changes in the temporary storage.



NOTENOTE

Validate a templateValidate a template

5. Close the Excel desktop application.

6. Select Sync stored copySync stored copy  to synchronize the temporary template storage to the permanent template

storage.

The copy of the editable template in the temporary file storage is kept for only the current session of template editing.

When you finish this session by closing the BDM template editorBDM template editor  page, this copy will be deleted. If you adjusted the

template in the temporary file storage and did not select Sync stored copySync stored copy , when you try to close the BDM templateBDM template

editoreditor  page, a message will ask whether you want to store introduced changes. Select YesYes if you want to save your

changes to the template in the permanent file location.

1. On the BDM template editorBDM template editor  page, select Check for issuesCheck for issues  to validate the modified template against

the underlying ER format configuration. Follow the recommendations (if any) to align the template with

the structure of the format from the base ER format configuration.

2. Select Show formatShow format to view the current structure of the format from the base ER format configuration

that must be aligned with the editable template.

3. Select Hide formatHide format to close the pane.

4. Close the BDM template editorBDM template editor  page.

The updated template is shown on the TemplateTemplate tab. Notice that the status of the edited template is now DraftDraft

and the current revision is no longer empty. This means that the process of this template's editing has been

started.



Test the modified templateTest the modified template
1. In the application, change to the company, USMFUSMF.

2. Go to Accounts receivableAccounts receivable > InvoicesInvoices  > All free text invoicesAll free text invoices .

3. Select the FTI-00000002FTI-00000002  invoice, and then select Pr int managementPrint management.

4. Select the Module - accounts receivableModule - accounts receivable > DocumentsDocuments  > Free text invoiceFree text invoice > Original documentOriginal document

level to specify the scope of invoices for processing.

5. In the Repor t formatRepor t format field, select the Customer FTI repor t (GER) CopyCustomer FTI repor t (GER) Copy  ER format for the specified

document level.

6. Press EscapeEscape to close the current page.

7. Select Pr intPr int, and then select SelectedSelected.

8. Download the document and open it using the Excel desktop application.



Create an alternative template revisionCreate an alternative template revision

The modified template is used to generate the free text invoice report for the selected item. To analyze how this

report is affected by the changes that you introduced to the template, you can run this report in one application

session right after you modified the template in another application session.

1. Open the BDM template editorBDM template editor  page and select the Customer FTI repor t (GER) CopyCustomer FTI repor t (GER) Copy  template.

2. On the RevisionsRevisions  tab, select NewNew .

3. If needed, in the NameName field, change the name of the second revision and base it on the currently active

first revision.

4. If needed, in the CommentComment field, change the remark for the automatically created revision of the editable

template.

You created a new revision of your template that has been stored in the permanent template's storage.

Now you can continue editing the template of the second revision that is currently selected as active.

5. Select the first revision and then select Set activeSet active. You can select another revision as active if at any time

you want to return to that revision of the template.

6. Select the second revision, and then select DeleteDelete.

7. Select OKOK to confirm that you want to delete the selected revision. You can delete any of the non-active



Delete a modified templateDelete a modified template

Revoke changes of templateRevoke changes of template

Publish a modified templatePublish a modified template

Frequently asked questions
I selected Edit document, but instead of going to the BDM template editor page in Finance, I was sent to theI selected Edit document, but instead of going to the BDM template editor page in Finance, I was sent to the
Microsoft 365 webpage.Microsoft 365 webpage.

I understand how to edit a template by using Microsoft 365 in the first application session, and how to useI understand how to edit a template by using Microsoft 365 in the first application session, and how to use
the template in the second application session and adjust the template to see how my changes affect thethe template in the second application session and adjust the template to see how my changes affect the
generated business document. Can I use the Office desktop application in the same way?generated business document. Can I use the Office desktop application in the same way?

revisions when they are no longer needed.

1. On the BDM template editorBDM template editor  page, select the TemplateTemplate tab.

2. Select DeleteDelete.

3. If you select OKOK to confirm deletion, the Customer FTI repor t (GER) CopyCustomer FTI repor t (GER) Copy  ER format with the modified

template will be deleted. Select CancelCancel  to explore other options.

When you edit the template from an ER format that is owned by the current active provider, you will be offered

the option to revoke changes introduced for the template.

1. On the BDM template editorBDM template editor  page, select the TemplateTemplate tab.

2. Select UndoUndo.

3. If you select OKOK to revoke the changes introduced for the template, the modified template will be replaced by

the original template and all changes will be removed. When you revoke changes to the template, you will be

able to delete the template. Select CancelCancel  to explore other options.

1. On the BDM template editorBDM template editor  page, on the TemplateTemplate tab, select PublishPublish .

2. If you select OKOK to confirm publishing, the draft version of the derived Customer FTI repor t (GER) CopyCustomer FTI repor t (GER) Copy

ER format that contains the modified template will be marked as completed. The modified template becomes

available for other users. The completed versions of this ER format will keep only the last active revision of

your template. Other revisions will be deleted. Select CancelCancel  to explore other options.

This issue is a known issue that involves Microsoft 365 redirection. It occurs when you sign to Microsoft 365 for

the first time. To work around this issue, select BackBack in your browser to return to the previous page.

Yes, you can. In the first application session, select Open in Desktop AppOpen in Desktop App. Your template will be stored in the

temporary file storage and opened in the Office desktop application. Next, complete the following steps to

preview your template changes in the generated business document:



 

When I select Open in Desktop App, I receive the following error message: "Value cannot be null. ParameterWhen I select Open in Desktop App, I receive the following error message: "Value cannot be null. Parameter
name: externalId." How do I work around this issue?name: externalId." How do I work around this issue?

Additional resources

List of ER configurations that have been released in Finance to
support configurable business documents

1. Make changes in the template by using the Office desktop application.

2. Select SaveSave in the Office desktop application.

3. On the BDM template editorBDM template editor  page of the first application session, select Sync stored copySync stored copy .

4. Execute this template ER format in the second application session.

Most likely you signed in to the current instance of the app of the Azure AD domain which differs from the

Azure AD domain that was used to deploy this instance. Because the SharePoint service, which is used to store

templates for making them available for editing by using the Office desktop applications, belongs to the same

domain, we have no permissions to access the SharePoint service. To resolve this issue, sign in to the current

instance using the credentials of a user with the correct Azure AD domain.

Electronic reporting (ER) overview

ER Design a configuration for generating reports in OPENXML format (November 2016)

Design ER configurations to generate reports in Word format

Embed images and shapes in documents that you generate by using ER

Configure Electronic reporting (ER) to pull data into Power BI

The list of ER configurations for Finance is constantly updated. Open the Global repository to review the list of

ER configurations that are currently supported. You can filter the Global repository to review the list of ER

configurations that are used to support configurable business documents.

The following table shows the list of ER configurations that support configurable business documents and that

have been released in Finance up until December 2020.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/analytics/er-download-configurations-global-repo
https://docs.microsoft.com/en-us/dynamics365/finance/localizations/enhanced-filtering-global-repo
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Bill of lading model Bill of lading (Excel)

Bill of lading (Word)

Certificate of origin model Certificate of origin (Excel)

Certificate of origin (Word)

Invoice model Customer Debit and Credit Note (Excel)

Customer Debit and Credit Note (Word)

Free text invoice (Excel)

Free text invoice (Excel) (BH)

Free text invoice (FR) (Excel)

Free text invoice (LT) (Excel)

Free text invoice (LV) (Excel)

Free text invoice (PL) (Excel)

Free text invoice (CZ) (Excel)

Free text invoice (EE) (Excel)

Free text invoice (HU) (Excel)

Free text invoice (TH) (Excel)

Free text invoice (Word)

Project contract line items (Excel)

Project contract line items (CZ) (Excel)

Project contract line items (Excel) (BH)

Project contract line items (HU) (Excel)

Project contract line items (LT) (Excel)

Project contract line items (PL) (Excel)

Project contract line items (Word)

Project customer retention release (Excel)



Project customer retention release (CZ) (Excel)

Project customer retention release (HU) (Excel)

Project customer retention release (LT) (Excel)

Project customer retention release (PL) (Excel)

Project customer retention release (TH) (Excel)

Project customer retention release (Word)

Project invoice (Excel)

Project Invoice (Word)

Project invoice (AE) (Excel)

Project invoice (CZ) (Excel)

Project invoice (Excel) (BH)

Project invoice (HU) (Excel)

Project invoice (JP) (Excel)

Project invoice (LT) (Excel)

Project invoice (PL) (Excel)

Project invoice (TH) (Excel)

Project invoice full (MY) (Excel)

Project invoice simple (MY) (Excel)

Project manage invoice (Excel)

Project manage invoice (CZ) (Excel)

Project manage invoice (Excel) (BH)

Project manage invoice (HU) (Excel)

Project manage invoice (JP) (Excel)

Project manage invoice (LT) (Excel)

Project manage invoice (PL) (Excel)
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Project manage invoice (Word)

Purchase advance invoice (Excel)

Purchase advance invoice (Word)

Sales advance invoice (Excel)

Sales advance invoice (Word)

Sales advance invoice (PL) (Excel)

Sales invoice (Excel)

Sales invoice (Excel) (BH)

Sales invoice (Excel) (CZ)

Sales invoice (Excel) (EE)

Sales invoice (Excel) (FR)

Sales invoice (Excel) (HU)

Sales invoice (Excel) (IN)

Sales invoice (Excel) (LT)

Sales invoice (Excel) (LV)

Sales invoice (Excel) (PL)

Sales invoice (Excel) (TH)

Sales invoice (Word)

TMS Commercial Invoice (Excel)

TMS Commercial Invoice (Word)

Vendor invoice document (Excel)

Vendor invoice document (CZ) (Excel)

Vendor invoice document (HU) (Excel)

Vendor invoice document (IN) (Excel)

Vendor invoice document (LT) (Excel)
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Vendor invoice document (LV) (Excel)

Vendor invoice document (MY) (Excel)

Vendor invoice document (Word)

Order model Agreement confirmation (Excel)

Agreement confirmation (Word)

Purchase agreement confirmation (Excel)

Purchase agreement confirmation (Word)

Purchase order (Excel)

Purchase order (CZ) (Excel)

Purchase order inquiry (CZ) (Excel)

Purchase order (HU) (Excel)

Purchase order inquiry (HU) (Excel)

Purchase order (Word)

Purchase order inquiry (Excel)

Purchase order inquiry (Word)

Sales order confirmation (Excel)

Sales order confirmation (CZ) (Excel)

Sales order confirmation (HU) (Excel)

Sales order confirmation (Word)

Packing list model Container contents (Excel)

Container contents (Word)

Load list (Excel)

Load list (Word)

Picking list (Excel)

Picking list (CZ) (Excel)
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Picking list (Word)

Production pick list (Excel)

Production pick list (Word)

Shipping pick list for load (Excel)

Shipping pick list for load (Word)

Shipping pick list for shipment (Excel)

Shipping pick list for shipment (Word)

Shipping pick list for wave (Excel)

Shipping pick list for wave (Word)

Payment model Customer payment advice (Excel)

Customer payment advice (Word)

Vendor payment advice (Excel)

Vendor payment advice (Word)

Quotation model Project quotation (Excel)

Project quotation (Word)

Request for quotation (Excel)

Request for quotation (Accept) (Excel)

Request for quotation (Accept) (Word)

Request for quotation (Reject) (Excel)

Request for quotation (Reject) (Word)

Request for quotation (Return) (Excel)

Request for quotation (Return) (Word)

Request for quotation (Word)

Sales quotation (Excel)

Sales quotation (CZ) (Excel)

DATA  M O DEL  C O N F IGURAT IO NDATA  M O DEL  C O N F IGURAT IO N F O RM AT  C O N F IGURAT IO N SF O RM AT  C O N F IGURAT IO N S



Sales quotation (HU) (Excel)

Sales quotation (Word)

Sales quotation confirmation (Excel)

Sales quotation confirmation (Word)

Reconciliation model Cust account statement, Ext (Excel)

Cust account statement, Ext (CN) (Excel)

Cust account statement, Ext (Word)

Cust account statement, France (Excel)

Reminder model Collection letter note (Excel)

Collection letter note (CN) (Excel)

Collection letter note (Word)

Customer interest note (Excel)

Customer interest note (Word)

Waybill model Load tender (Excel)

Load tender (Word)

Purchase order packing slip (Excel)

Purchase order packing slip (CZ) (Excel)

Purchase order packing slip (Word)

Route (Excel)

Route (Word)

Sales order packing slip (Excel)

Sales order packing slip (CZ) (Excel)

Sales order packing slip (LT) (Excel)

Sales order packing slip (PL) (Excel)

Sales order packing slip (Word)
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NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


New document user interface in Business document
management
2/18/2021 • 2 minutes to read • Edit Online

Make the new document UI in Business document management
available

Edit templates that are owned by other providersEdit templates that are owned by other providers

Business document management lets business users edit business document templates by using a Microsoft

365 service or the appropriate Microsoft Office desktop application. Edits might include design changes or new

deployments, or users might add placeholders to include additional data without having to change the source

code. For more information about how to work with Business document management, see Business document

management overview.

The new document user interface (UI) is clearer and more comfortable to use. The Business documentBusiness document area

shows only the templates that are available for the current provider.

The New documentNew document button lets users create and edit a template in an Electronic reporting (ER) format

configuration that is provided by another provider. In the example in this topic, the provider is Microsoft.

To start to use the new document UI in Business document management, you must turn on the Office-like UIOffice-like UI

experience for Business document managementexperience for Business document management feature in the Feature managementFeature management workspace.

Follow these steps to turn on this feature for all legal entities.

1. In the Feature managementFeature management workspace, on the NewNew  tab, select the Office-like UI experience forOffice-like UI experience for

Business document managementBusiness document management feature in the list.

2. Select Enable nowEnable now  to turn on the selected feature.

3. Refresh the page to access the new feature.

1. In the Business document managementBusiness document management workspace, select New documentNew document.

2. In the dialog box, select the document to use as a template, and then select Create documentCreate document.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-business-document-management-new-template-ui.md


NOTENOTE

3. In the new dialog box, in the TitleTitle field, change the title as you require. The title text is used to name the

new ER format configuration that is automatically created. The draft version of this configuration

(Customer FTI repor t (GER) CopyCustomer FTI repor t (GER) Copy) will contain the edited template and will be used to run this ER

format for the current user. The original template from the base ER format configuration will be used to

run this ER format for every other user.

4. In the NameName field, change the name of the first revision of the editable template that will be automatically

created.

5. In the CommentComment field, update the remarks for the revision of the editable template that will be

automatically created.

6. Select OKOK to confirm the start of the editing process.

The New documentNew document button is used to create and edit a template in an ER format configuration that is provided

by another provider. In this example, the provider is Microsoft. When you select New documentNew document, you can view

all the templates that are owned by current and other providers. After you select the template, it's opened for

editing. The edited template will then be stored in a new ER format configuration that is automatically

generated.

For more information, see Business document management overview.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Add new fields to a business document template in
Microsoft Excel
2/18/2021 • 5 minutes to read • Edit Online

Configure Business document management to edit templates

Import ER solutions that contain a template

You can add new fields to a template that is used to generate business documents in Microsoft Excel format.

These fields can be added as placeholders that are used to fill generated documents with required information

from the application. For every field that you add, you can also specify a binding to the data sources, to specify

what application data will be entered in the field when the template is used to generate business documents.

To learn more about this feature, complete the example in this topic. This example shows how to update a

template to fill in the fields in free text invoice forms that are generated.

Because Business document management (BDM) is built on top of the Electronic reporting (ER) overview

framework, you must configure the required ER and BDM parameters before you can start to work with BDM.

1. Sign in to the instance of Microsoft Dynamics 365 Finance as the system administrator.

2. Complete the following steps of the example in the Business document management overview topic:

a. Configure ER parameters.

b. Turn on BDM.

You can now start to use BDM to edit business document templates.

The example in this procedure uses the officially published ER solution. You must import the ER configurations

of this solution into your current instance of Finance.

The Free text invoice (Excel)Free text invoice (Excel)  ER format configuration of this solution contains the business document

template in Excel format that can be edited by using BDM. Import the latest version of this ER format

configuration from Microsoft Dynamics Lifecycle Service (LCS). The corresponding ER data model and ER model

mapping configurations will be imported automatically.

For more information about how to import ER configurations, see Manage the ER configuration lifecycle.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-bdm-add-field-to-excel-template.md


Edit the ER solution templateEdit the ER solution template
1. Sign in as a user who has access to the Business document managementBusiness document management workspace.

2. Open the Business document managementBusiness document management workspace.

3. In the grid, select the Free text invoice (Excel)Free text invoice (Excel)  template.

4. In the right pane, select New templateNew template to create a new template that is based on the selected template.

5. In the TitleTitle field, enter Free text invoice (Excel) ContosoFree text invoice (Excel) Contoso as the title of the new template.

6. Select OKOK to confirm the start of the editing process.

The BDM template editor page appears. You can use Microsoft 365 to edit the selected template online in the

embedded control.



Add the label for a new field to the templateAdd the label for a new field to the template
1. On the BDM template editor page, on the Excel ribbon, on the ViewView  tab, select the Headings andHeadings and

GridlinesGridlines  check boxes for the editable Excel template.

2. Select cells E8:F8E8:F8 .

3. On the Excel ribbon, on the HomeHome tab, select Merge & CenterMerge & Center  to merge the selected cells into a new

merged E8:F8E8:F8  cell.

4. In the merged cell E8:F8E8:F8 , enter URLURL .

5. Select merged cell E7:F7E7:F7 , select Format painterFormat painter , and then select merged cell E8:F8E8:F8  to format it in the

same way as merged cell E7:F7E7:F7 .



Format the template to reserve space for a new fieldFormat the template to reserve space for a new field
1. On the BDM template editor page, select merged cell G8:H8G8:H8 .

2. On the Excel ribbon, on the HomeHome tab, select Merge & CenterMerge & Center  to merge the selected cells into a new

merged G8:H8G8:H8  cell.

3. Select merged cell G7:H7G7:H7 , select Format painterFormat painter , and then select merged cell G8:H8G8:H8  to format it in the

same way as merged cell G7:H7G7:H7 .

4. In the NameName box field, select CompanyInfoCompanyInfo.

The CompanyInfoCompanyInfo range of the current Excel template holds all the fields that are used to fill the header

of a generated report with the details of the current company as a seller party.



Add a new field to the templateAdd a new field to the template

NOTENOTE

1. On the BDM template editorBDM template editor  page, on the Action Pane, select Show formatShow format.

2. In the Template structureTemplate structure pane, select AddAdd.

You must adjust the section of the template that you want to use as a new field. You already made this

adjustment by formatting merged cell G8:H8G8:H8 .

3. Select Excel\CellExcel\Cell  to add a new field as a cell in the template.

You can select Excel\RangeExcel\Range if you want to add a new range to the template. The range that is entered

can contain multiple cells. You can add these cells later.

Notice that the CompanyInfoCompanyInfo template component, is automatically selected in the Template structureTemplate structure

pane, because it's the most suitable parent component in the current template structure for the field that

you're adding.

4. In the Excel rangeExcel range field, enter CompanyURL_ValueCompanyURL_Value.

5. Select OKOK.



6. In the Template structureTemplate structure pane, select the ellipsis button (...), and then select Show bindingsShow bindings .

The Template structureTemplate structure pane now shows the data sources that are available in the underlying ER

format.

7. Select CompanyInfo_ValueCompanyInfo_Value as the field that you plan to bind to a data source of the underlying ER

format.

8. In the Data sourcesData sources  section of the Template structureTemplate structure pane, expand Model > InvoiceBase >Model > InvoiceBase >

CompanyInfoCompanyInfo.

9. Under CompanyInfoCompanyInfo, select the WebsiteURIWebsiteURI item.



Review company settings

10. Select BindBind.

11. In the Template structureTemplate structure pane, select SaveSave, and then close the BDM template editor page.

In the Business document managementBusiness document management workspace, the TemplateTemplate tab in the right pane shows the updated

template. In the grid, notice that the StatusStatus  field for the edited template has been changed to DraftDraft, and the

RevisionRevision field is no longer blank. These changes indicate that the process of editing this template has been

started.

1. Go to Organization administration > Organizations > Legal entitiesOrganization administration > Organizations > Legal entities .

2. On the Contact informationContact information FastTab, verify that the company URL is entered.



Generate business documents to test the updated template
1. In the application, change the company to USMFUSMF, and go to Accounts receivable > Invoices > AllAccounts receivable > Invoices > All

free text invoicesfree text invoices .

2. Select invoice FTI-00000002FTI-00000002 , and then select Pr int managementPrint management.

3. In the left pane, expand Module - accounts receivable > Documents > Free text invoiceModule - accounts receivable > Documents > Free text invoice.

4. Under Free text invoiceFree text invoice, select the Original documentOriginal document level to specify the scope of invoices for

processing.

5. In the right pane, in the Repor t formatRepor t format field, select the Free text invoice (Excel) ContosoFree text invoice (Excel) Contoso template

for the specified document level.

6. Press EscEsc to close the current page.

7. Select Pr int > SelectedPrint > Selected.

8. Download the generated document, and open it in Excel.



Related links

NOTENOTE

The modified template is used to generate the free text invoice report for the selected item. To analyze how this

report is affected by changes that you make to the template, run the report in one application session

immediately after you change the template in another application session.

Electronic reporting (ER) overview

Business document management overview

Design a configuration for generating reports in OPENXML format
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The survey will take about seven minutes. No personal data is collected (privacy statement).
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Various types of functions are supported in Electronic reporting expressions for data transformation – text, date

and time, mathematical logical, information, data type conversion, and other (business domain–specific

functions). In addition to built-in functions, Electronic reporting lets you extend the list of available functions.

This article includes an overview of key tasks that you must complete to introduce a new function.

All Electronic reporting functions in application code are represented as classes that extend the ERExpressionERExpression

class. Two types of functions are recognized:

Fixed number of argumentsFixed number of arguments  – These functions are represented by classes that include methods that have

the prefix parmparm (see parmInputparmInput, parmStar tNumparmStar tNum in the sample code the follows). The order of arguments

is set by the SysOperationDisplayOrderAttr ibuteSysOperationDisplayOrderAttr ibute attribute.

Var iable number of argumentsVariable number of arguments  – These functions (see the ERExpressionGenericCaseERExpressionGenericCase class) are

represented by classes that implement the ERIObjectContainerERIObjectContainer  interface. An additional AddAdd method is

used to declare the types that a function accepts.

Here are the recommended steps for introducing a new function for Electronic reporting expressions:

Select a base class for your function, based on the return value type (see ERExpressionStr ingERExpressionStr ing in the

sample code that follows).

Create a new class that extends the selected class (see ERExpressionStr ingMidERExpressionStr ingMid in the sample

code the follows).

Provide required attributes:

SysOperationLabelAttr ibuteSysOperationLabelAttr ibute – This attribute defines the function’s name.

SysOperationHelpTextAttr ibuteSysOperationHelpTextAttr ibute – This attribute defines the function’s Help text.

ERComponentGroupAttr ibuteERComponentGroupAttr ibute – This attribute defines the group that the function

belongs to. (For more information, see Formula designer in Electronic reporting (ER).)

Provide arguments:

For a fixed number of arguments function, provide methods that have the prefix parmparm,

and use the SysOperationDisplayOrderAttr ibuteSysOperationDisplayOrderAttr ibute attribute to set the order of the

arguments.

For a variable number of argument function, implement the ERIObjectContainerERIObjectContainer

interface.

Provide an evaluation method.

Here is an example.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/general-electronic-reporting-formulas-list-extension.md


/// <summary>
/// Returns the characters from the middle of a text string, given a starting position and length.
/// </summary>
[
    SysOperationLabelAttribute ('MID'),
    SysOperationHelpTextAttribute ("@ElectronicReporting:ExpressionStringMidHelpText"),
    ERComponentGroupAttribute ("@ElectronicReporting:String")
]
class ERExpressionStringMid extends ERExpressionString
{
    ERExpressionString input;
    ERExpressionInt startNum;
    ERExpressionInt numChars;
    public str evaluateString(ERIDataContext _dataContext)
    {
        return subStr(
            this.parmInput().evaluateString(_dataContext),
            this.parmStartNum().evaluateInt(_dataContext),
            this.parmNumChars().evaluateInt(_dataContext));
    }
    [DataMemberAttribute, SysOperationLabelAttribute ("@ElectronicReporting:Input"), 
SysOperationDisplayOrderAttribute ("1")]
    public ERExpressionString parmInput(ERExpressionString _input = input)
    {
        input = _input;
        return input;
    }
    [DataMemberAttribute, SysOperationLabelAttribute ("@ElectronicReporting:NumChars"), 
SysOperationDisplayOrderAttribute ("3")]
    public ERExpressionInt parmNumChars(ERExpressionInt _numChars = numChars)
    {
        numChars = _numChars;
        return numChars;
    }
    [DataMemberAttribute, SysOperationLabelAttribute ("@ElectronicReporting:StartNum"), 
SysOperationDisplayOrderAttribute ("2")]
    public ERExpressionInt parmStartNum(ERExpressionInt _startNum = startNum)
    {
        startNum = _startNum;
        return startNum;
    }
    public str toString()
    {
        return ERExpressionStringPresenter::namedFunctionToStr(this);
    }
}

Suggested guidance
The following guidance is intended to help you design your custom Electronic reporting functions:

Reuse the names of Microsoft Excel functions whenever you can, so that Electronic reporting formulas

remain Excel-like. In this way, you will keep Electronic reporting formulas intelligible for end users.

Electronic reporting doesn't support list types for primitive data types. Therefore, we have decided to use a

data container list that has a single ValueValue item in it.

Release a new function's list extension as a new application hotfix. Electronic reporting designers will refer to

the hotfix number in Electronic reporting configurations that use that new custom function. Whenever a

configuration of this type is imported into a new instance, Electronic reporting will evaluate whether the

required hotfix has been installed, to maintain compliance between the Electronic reporting configuration

and the version that configuration is imported into.



Additional resources
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Electronic reporting (ER) overview

Formula designer in Electronic reporting (ER)
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How to access classes that were moved from X++ to an external
assembly

using Microsoft.Dynamics365.LocalizationFramework;

var destination = new ERFileDestinationMemory();

using LF = Microsoft.Dynamics365.LocalizationFramework;

var destination = new LF.ERFileDestinationMemory();

How to access internal X++ objects by using ERObjectsFactory

Code to display a format mapping lookupCode to display a format mapping lookup

// pattern
ERFormatMappingTableLookup::lookupFormatMapping(<form control>, <model name>[, <data container name>]);
// sample code
ERFormatMappingTableLookup::lookupFormatMapping(_referenceGroupControl, bankLCMiscChargeReportERModelName);

This topic describes how the API of the Electronic reporting (ER) framework has been changed in the Dynamics

365 for Finance and Operations, Enterprise edition Application update 7.3.

There are two types of changes to the ER APIs:

Several X++ classes were moved from X++ to an external assembly.

The rest of X++ classes were marked as internal.

To access external classes, you need to add the usingusing directive to the beginning of your file.

You can then access an external class without any additional changes, for example.

You can also create an alias for your namespace.

You can then refer to an external class by using the namespace alias that you created.

In Application update 7.3 and later updates, the calling code must access the ER objects by using the methods of

the ERObjectsFactor yERObjectsFactor y  class. Several examples of these changes are shown.

Before Application update 7.3

Application update 7.3 and later

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-apis-app73.md


    

// pattern
ERObjectsFactory::createFormatMappingTableLookupForControlAndModel(<form control>, <model name>[, <data 
container name>]).performFormLookup();
// sample code
ERObjectsFactory::createFormatMappingTableLookupForControlAndModel(_referenceGroupControl, 
bankLCMiscChargeReportERModelName).performFormLookup();

Code to run a format mapping for data exportCode to run a format mapping for data export

// pattern
ERFormatMappingRun::constructByFormatMappingId(<format mapping id>, <file name>, <show prompt 
dialog>).run();
// sample code
ERFormatMappingRun::constructByFormatMappingId(erBinding, '', true).run();

// pattern
ERObjectsFactory::createFormatMappingRunByFormatMappingId(<format mapping id>, <file name>, <show prompt 
dialog>).run();
// sample code
ERObjectsFactory::createFormatMappingRunByFormatMappingId(erBinding, '', true).run();

Code to run a format mapping for data importCode to run a format mapping for data import

// pattern
ERModelMappingDestinationRun::constructByImportFormatMappingId(<mapping id>, <integration point>).run();
// sample code
ERModelMappingDestinationRun::constructByImportFormatMappingId(custPaymModeTable.ERModelMappingTable, 
CustVendOutPaymConstants::IntegrationPoint).run();

// pattern
ERObjectsFactory::createMappingDestinationRunByImportFormatMappingId(<mapping id>, <integration 
point>).run();
// sample code
ERObjectsFactory::createMappingDestinationRunByImportFormatMappingId(custPaymModeTable.ERModelMappingTable, 
CustVendOutPaymConstants::IntegrationPoint).run();

Code to create a browser file destinationCode to create a browser file destination

// sample code
new ERFileDestinationBrowser();

// sample code
ERObjectsFactory::createFileDestinationBrowser();

Code to create an attachment file destinationCode to create an attachment file destination

Before Application update 7.3

Application update 7.3 and later

Before Application update 7.3

Application update 7.3 and later

Before Application update 7.3

Application update 7.3 and later



// pattern
ERFileDestinationAttachment::construct(<record>, ERDocuManagement::instance().otherDocuType());
// sample code
ERFileDestinationAttachment::construct(_cashRegisterFiscalTrans_W, 
ERDocuManagement::instance().otherDocuType());

// pattern
ERObjectsFactory::createFileDestinationAttachmentWithOtherDocuType(<record>);
// sample code
ERObjectsFactory::createFileDestinationAttachmentWithOtherDocuType(_cashRegisterFiscalTrans_W);

NOTENOTE

Before Application update 7.3

Application update 7.3 and later
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Prerequisites

Create or import an ER format configuration

IMPORTANTIMPORTANT

Create a new document type

The application programming interface (API) of the Electronic reporting (ER) framework lets you extend the list

of storage locations for documents that ER formats generate. This topic includes an overview of the main tasks

that you must complete to add a custom storage location.

You must deploy a topology that supports continuous build. (For more information, see Deploy topologies that

support continuous build and test automation.) You must have access to this topology for one of the following

roles:

Electronic reporting developer

Electronic reporting functional consultant

System administrator

You must also have access to the development environment for this topology.

In the current topology, create a new ER format to generate documents that you plan to add a custom storage

location for. Alternatively, import an existing ER format into this topology.

The ER format that you create or import must contain at least one of the following format elements:

File

Folder

Merger

Attachment

To specify how documents that an ER format generates are routed, you must configure Electronic reporting (ER)

destinations. In each ER destination that is configured to store generated documents as files, you must specify a

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/analytics/er-custom-storage-generated-documents.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/perf-test/continuous-build-test-automation


NOTENOTE

Review source code

document type of the Document management framework. Different document types can be used to route

documents that different ER formats generate.

1. Add a new document type for the ER format that you created or imported earlier. In the illustration that

follows, the document type is FileXFileX.

2. To differentiate this document type from other document types, include a specific keyword in its name. For

example, in the illustration that follows, the name is (LOCAL) folder(LOCAL) folder .

3. In the ClassClass  field, specify Attach fileAttach file.

4. In the GroupGroup field, specify FileFile.

Document types are company-specific. To use an ER format with a configured destination in multiple companies, you must

configure a separate document type in each company.

Review the code of the inser tFile()inser tFile()  method of the ERDocuManagementERDocuManagement class. Notice that the

AttachingFile()AttachingFile()  event is raised while the generated file is attached to a record.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/organization-administration/configure-document-management


/// <summary>
/// Inserts file as attachment in Document Management.
/// </summary>
/// <param name = "_owner">A record as the attachment owner.</param>
/// <param name = "_stream">The file stream.</param>
/// <param name = "_filePath">The file path with name.</param>
/// <param name = "_attachmentName">The name of file attachment.</param>
/// <returns>The reference to inserted file.</returns>
[Hookable(false)]
public DocuRef insertFile(
    Common _owner, 
    System.IO.Stream _stream, 
    str _filePath, 
    str _attachmentName, 
    DocuTypeId _docuTypeId)
{
    DocuRef docuRef;
    if (_stream)
    {
        DocuType::createDefaults();
        if (!this.isDocuTypeValid(_docuTypeId))
        {
            throw error(strFmt("@ElectronicReporting:DocuTypeIsNotValid", _docuTypeId));
        }
        var args = ERDocuManagementAttachingFileEventArgs::construct(_owner, _stream, _filePath, 
_attachmentName, _docuTypeId);
        ERDocuManagementEvents::onAttachingFile(args);
        if (args.isHandled())
        {
            docuRef = args.getDocuRef();
        }
        else
        {
            docuRef = this.attachFile(_owner, _stream, _filePath, _attachmentName, _docuTypeId);
        }
    }
    return docuRef;
}

The AttachingFile()AttachingFile()  event is raised when the following ER destinations are processed:

ArchiveArchive – When this destination is used, a new record for the ER format that is run is created in the

ERFormatMappingRunJobTable table. The ArchivedArchived field in this record is set to FalseFalse. If the ER format is

successfully run, the generated document is attached to this record, and the AttachingFile()AttachingFile()  event is raised.

The document type that is selected in this ER destination determines the storage location for the attached file

(Microsoft Azure Storage or a Microsoft SharePoint folder).

Job archiveJob archive – When this destination is used, a new record for the ER form that is run is created in the

ERFormatMappingRunJobTable table. The ArchivedArchived field in this record is set to TrueTrue. If the ER format is

successfully run, the generated document is attached to this record, and the AttachingFile()AttachingFile()  event is raised.

The document type that is configured in the ER parameters determines the storage location for the attached

file (Azure Storage or a SharePoint folder).



Configure an ER destination

Modify source code

1. Configure the archived destination for one of the previously mentioned elements (file, folder, merger, or

attachment) of the ER format that you created or imported. For guidance, see ER Configure destinations.

2. Use the document type that you added earlier for the configured destination. (For the example in this topic,

the document type is FileXFileX.)

1. Add a new class to your Microsoft Visual Studio project, and write code to subscribe to the

AttachingFile()AttachingFile()  event that was mentioned earlier. (For more information about the extensibility pattern

that is used, see Respond by using EventHandlerResult.) For example, in the new class, write code that

performs the following actions:

a. Store generated files in a folder of the local file system of the server that runs the Application Object

Server (AOS) service.

b. Store these generated files only when the new document type (for example, the FileXFileX type that has

the "(LOCAL)" keyword in its name) is used while a file is attached to the record in the ER execution job

log.

https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/analytics/tasks/er-destinations-2016-11
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/extensibility/respond-event-handler-result


Run the ER format that you created or imported

Additional resources

NOTENOTE

class ERDocuSubscriptionSample
{
    void new()
    {
    }
    [SubscribesTo(classStr(ERDocuManagementEvents), 
    staticDelegateStr(ERDocuManagementEvents, 
    attachingFile))]
    public static void ERDocuManagementEvents_attachingFile(ERDocuManagementAttachingFileEventArgs 
_args)
    {
        if (!_args.isHandled())
        {
            DocuType docuType = DocuType::find(_args.getDocuTypeId());
            if (strContains(docuType.Name, '(LOCAL)'))
            {
                _args.markAsHandled();
                var stream = _args.getStream();
                if (stream.CanSeek)
                {
                    stream.Seek(0, System.IO.SeekOrigin::Begin);
                }
                using (var localStream = System.IO.File::OpenWrite(@'c:\0\' + 
_args.getAttachmentName()))
                {
                    stream.CopyTo(localStream);
                }
            }
        }
    }
}

2. Rebuild your project.

1. Execute the ER format that you created or imported.

2. Go to Organization administration > Electronic repor ting > Electronic repor ting jobsOrganization administration > Electronic repor ting > Electronic repor ting jobs . Find the

record that was created for this execution job, and that has the generated file attached to it.

3. Explore the local C:\0C:\0  folder to find same generated file.

Electronic reporting (ER) destinations

Extensibility home page
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Learning map

Additional resources
What's new and in developmentWhat's new and in development

Inventory accountingInventory accounting

Manufacturing and Supply Chain Management blogsManufacturing and Supply Chain Management blogs

Task guidesTask guides

You can use Inventory management to perform the following tasks:

Inbound operations

Quality assurance

Inventory activities

Outbound operations

Inventory control

The following learning map shows the major concepts and tasks that make up the framework of the Inventory

management module. Click the learning map below to expand it. This learning map will help you get started.

Go to the Microsoft Dynamics 365 Roadmap to see what new features have been released and what new

features are in development.

To learn more, see Inventory close.

You can find opinions, news, and other information about Inventory management and other solutions on the

Dynamics AX Manufacturing R&D Team Blog and Supply Chain Management in Dynamics AX R&D Team Blog.

Additional help is available as task guides. To access task guides, click the HelpHelp button on any page

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/inventory-home-page.md
file:///T:/eiye/ac1a/dynamics365/supply-chain/inventory/media/inventory-learning-map.png
https://roadmap.dynamics.com/
https://blogs.msdn.microsoft.com/axmfg
https://blogs.msdn.microsoft.com/dynamicsaxscm
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Business scenario

Arrival overview page

Arrival overview profilesArrival overview profiles

Set up item arrivalSet up item arrival

This topic provides information about the Arrival overview feature. The Arrival overview page is part of this

feature and provides an overview of all items that are expected to arrive as incoming items.

The Arr ival over viewArr ival over view  page provides an overview of all expected incoming items. It also shows arrivals that can

be initialized based on the overview. This topic focuses on the receiving process.

Consider the following scenario in the inbound processes.

Sammy, a receiving clerk, wants to know what is expected to be received on the current day. On the Arr ivalArr ival

over viewover view  page, Sammy can get an overview of the current tasks, and a rough estimate of quantities, volume,

weight, different order types, and so on. Later, a delivery arrives at one of the inbound docks, and Sammy

receives a list of the delivery. On the Arr ival over viewArr ival over view  page, Sammy can perform the following tasks:

Identify the matching receipt order, and register the receipt as In progressIn progress . The lines that are required for a

registration are automatically generated, and the receipt can be monitored, even though the transactions

haven't yet been posted as RegisteredRegistered.

Access the appropriate arrival journal reference (that is, the Item arr ivalItem arr ival  journal or the Production inputProduction input

journal), and identify journals that are ready for a product receipt update.

To open the Arr ival over viewArr ival over view  page, click Inventor y managementInventor y management > Inbound ordersInbound orders  > Arr ival over viewArr ival over view .

You can view a list of orders that are expected to be received. The overview is divided into a header and lines.

The header information is grouped by the order type, expected receipt date, and delivery destination. When a

header line is selected for arrival, all the detail lines that are related to the receipt reference are selected for

arrival in the line details part of the page. When all related journal lines have been posted, this information isn't

shown.

The Arr ival over viewArr ival over view  page provides an overview of items that are expected to arrive and the date when they

are expected to arrive. As part of the arrival process, multiple sets of personal settings can be used. Individual

users can define their personal settings on the Arr ival over view profilesArr ival over view profiles  page.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/arrival-overview.md
file:///T:/eiye/ac1a/dynamics365/supply-chain/inventory/media/arrival-overview-scenario.png


Prerequisites for arrival journalsPrerequisites for arrival journals

Items that are received from one expected receipt orderItems that are received from one expected receipt order

Items that are received from more than one expected receipt orderItems that are received from more than one expected receipt order

Receive items from one or more expected receipt ordersReceive items from one or more expected receipt orders
View informationView information

In our example, Sammy wants to set up a new computer at a location that will be used to receive finished goods

that come from production at Site 1. On the Arr ival over view profilesArr ival over view profiles  page, Sammy creates a new setup that

is named Site 1 productionSite 1 production and specifies the following settings.

1. On the Arr ival optionsArr ival options  FastTab, in the RangeRange field group, enter information about a day interval and the

warehouses to include in the overview.

2. On the Arr ival optionsArr ival options  FastTab, in the JournalJournal  field group, enter a receiving warehouse, a location, and a

journal name (item arrival/production input).

3. On the Arr ival quer y detailsArr ival quer y details  FastTab, in the S iteSite field group, in the Restr ict to siteRestr ict to site field, enter a site to

limit the view in the overview area.

4. On the Arr ival quer y detailsArr ival quer y details  FastTab, in the Transaction types shownTransaction types shown field group, set the ProductionProduction

ordersorders  option to YesYes .

5. On the Arr ival quer y detailsArr ival quer y details  FastTab, in the MiscellaneousMiscellaneous  group, set the Update on star tupUpdate on star tup option to

YesYes  if the view should be automatically updated at startup. Set the Update on range changeUpdate on range change option to YesYes

if the view should be automatically updated when range values are changed.

For this example, the Arr ival over view profile nameArr ival over view profile name field on the Arr ival optionsArr ival options  FastTab of the Arr ivalArr ival

over viewover view  page is set to S ite 1 productionSite 1 production.

To automatically create arrival journals from the Arr ival over viewArr ival over view  page, you must define appropriate

information in the JournalJournal  field group on the Arr ival optionsArr ival options  FastTab.

You must specify a journal name to create a journal.

If you specify values in the WarehouseWarehouse and LocationLocation fields, those values are applied on the journal lines. If

you don't specify values, the system uses the values from the dimension that is specified on the inventory

transactions.

On the ReceiptsReceipts  FastTab, Sammy selects a line and then clicks Star t arr ivalStar t arr ival . All related lines that are in the

specified range and that have a quantity to register are automatically selected. An item arrival journal is

generated that has a match between the expected receipt order and the journal. The quantity is automatically

initialized on all lines that are created.

On the ReceiptsReceipts  FastTab, Sammy selects multiple lines and then clicks Star t arr ivalStar t arr ival . An item arrival journal is

generated that has a match between all the expected receipt orders and the journal. All lines are created on one

item arrival journal header, and the quantity is automatically initialized.

To get an overview of expected receipts in a date interval, Sammy enters the following information in the fields

on the Arr ival optionsArr ival options  FastTab on the Arr ival over viewArr ival over view  page and then clicks UpdateUpdate to update the view:

Arrival overview profile name: Inquir yInquir y

Show lines: AllAll

file:///T:/eiye/ac1a/dynamics365/supply-chain/inventory/media/arrival-overview-journal.png


Update journalsUpdate journals

Start an arrival registrationStart an arrival registration

Update arrival information and process a product receipt

Summary

Days back: (Blank)

Days forward: 00

Warehouses: GW, MWGW, MW

Sammy can view the following information:

All related receipt orders for the system date and an infinite number of days back from it (the

InventTrans.StatusDateInventTrans.StatusDate interval), and receipts to warehouses GW and MW, regardless of status.

Detailed line information for more than one order. Sammy can select multiple header lines in the overview

and then click Show all selectedShow all selected to view all the corresponding line detail information for all selected orders.

Information about a specific purchase order. To show only information that is related to a specific reference

number in the overview, Sammy can enter an account number in the Account numberAccount number  field and an order

number in the Reference numberReference number  field.

An overview of the registration tasks that are due for all the order lines that an item arrival journal has been

created for but hasn't yet been posted. To view this information, Sammy can select In progressIn progress  in the ShowShow

lineslines  field.

To register one or more order lines that are due to be processed, Sammy can select the lines in the overview

grid or in the line grid, and then click JournalsJournals  > Show arr ivals from receiptsShow arr ivals from receipts . The item arrival headers that

match the lines are shown. To update the purchase order product receipt for the registered items, Sammy can

access the item arrival journal headers that are ready for update. To access these item arrival journal headers, he

clicks JournalsJournals  > Product receipt ready journalsProduct receipt ready journals . All the header lines that are ready for product receipt

update in the specified warehouse range are shown. (The header lines that are shown aren't related to the day

interval).

By selecting multiple lines on the Arr ival over viewArr ival over view  page, Sammy can start an arrival of more than one receipt

reference. When he selects a line from the receipts overview, the corresponding line details are selected. If a

quantity for registration exists, the Star t arr ivalStar t arr ival  button is available. Sammy can use two methods to start the

arrival registration:

To filter the page so that it shows only records that meet specific criteria, in the Vendor referenceVendor reference field, scan

a reference number from a vendor, such as the bar code for a delivery note.

In the overview part or the details part of the Arr ival over viewArr ival over view  page, manually select or cancel the

selection of records for arrival registration. Then, when Sammy clicks Star t arr ivalStar t arr ival , the selected records are

automatically created in an item arrival journal. The records include line information, and all unique field

information is assigned.

When all goods have been registered, the warehouse manager or purchasing manager can update the received

items with a product receipt to add the physical cost. To update arrival information and post a product receipt,

follow these steps.

1. Click Inventor y managementInventor y management > Inbound ordersInbound orders  > Arr ival over viewArr ival over view .

2. On the Arr ival over viewArr ival over view  page, click JournalsJournals  > Product receipt ready journalsProduct receipt ready journals  to show a list of the

journals that are ready for product receipt update.

3. Select the journals that must be updated, and then click FunctionsFunctions  > Product receiptProduct receipt.

4. On the PostingPosting page, enter the product receipt number, if it isn't already available on the journal, and then

click OKOK to process the product receipt.
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The Arr ival over viewArr ival over view  page can help the warehouse manager and warehouse workers achieve an overview of

expected work that must be done as part of an inbound process. The page can also be used to start the item

arrival process, to help guarantee that items are tracked at the first entry into the warehouse.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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This topic focuses on the setup of an arrival overview profile. The arrival overview profile is a collection of rules

that will be applied when the Arrival overview page is opened by a user. You can use this procedure in demo

data company USMF. This procedure would typically be carried out by a receiving clerk.

1. In the navigation pane, go to Modules > Inventor y management > Setup > Distr ibution >Modules > Inventor y management > Setup > Distr ibution >

Arr ival over view profilesArr ival over view profiles .

2. Select NewNew . Because you will almost always work in the same warehouse offloading full truck loads, you

should create an arrival overview profile to simplify the process of registering received items.

3. In the Arr ival over view profile nameArr ival over view profile name field, type a value.

4. In the Show linesShow lines  field, select an option. Select which lines to show for the receipts:

AllAll  – Show all lines, regardless of status.

In progressIn progress  – Show lines for receipts in which the progress is Complete or Partly. This means that for

each line, either the full quantity or part of the quantity has been registered in an arrival journal.

Not completeNot complete – Show lines for receipts in which the progress is None or Partly. This means that for

each line, nothing or only part of the quantity has been registered in an arrival journal.

5. Expand or collapse the Arr ival optionsArr ival options  section.

6. In the Days for wardDays for ward field, type a value. This sets a filter to show the receipt lines expected to be received

within the next few days (depending on the number you set).

7. In the Days backDays back field, type a value. This sets a filter to show the receipt lines expected to be received a

number of days before today.

8. In the WarehousesWarehouses  field, type a value. Filter on one or more warehouses.

9. In the Mode of deliver yMode of deliver y  field, select a value. This sets a filter to show only the receipt lines with this

Mode of delivery.

10. In the NameName field, select WHS.

11. In the WarehouseWarehouse field, select warehouse 24. This is the default warehouse that will be used for

registered receipt lines that use this profile.

12. In the LocationLocation field, select BaydoorBaydoor . This is the default location that will be used for registered receipt

lines that use this profile.

13. Expand or collapse the Arr ival quer y detailsArr ival quer y details  section.

14. In the Restr ict to siteRestr ict to site field, select site 2. This sets a filter to show only the receipt lines with this site.

15. Set the Purchase ordersPurchase orders  option to YesYes . Select receipt lines from purchase orders.

16. Set the TransferTransfer  orders option to YesYes . Select receipt lines from transfer orders.

17. Select SaveSave.

18. Close the page.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/tasks/set-up-item-arrival-overview-profile.md
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Examples of the use of quality management

NOTENOTE

Working with quality associations

This topic describes how you can use quality management in Dynamics 365 Supply Chain Management to help

improve product quality within your supply chain.

Quality management can help you manage turnaround times when you handle nonconforming products,

regardless of their point of origin. Because diagnostic types are linked to correction reporting, Supply Chain

Management can schedule tasks to correct problems and prevent them from recurring.

In addition to functionality for managing nonconformance, quality management includes functionality for

tracking issues by problem type (even internal problems), and for identifying solutions as short-term or long-

term. Statistics about key performance indicators (KPIs) provide insight into the history of previous

nonconformance issues and the solutions that were used to correct them. You can use historical data to review

the effectiveness of previous quality measures and determine appropriate measures to use in the future.

When you set up a quality association, Supply Chain Management can generate quality orders for various

business processes, events, and conditions. The quality association can cover a specific item, a specific group of

items, or all items.

Quality management is flexible and can be implemented in various ways to meet the requirements of specific

levels of supply chain operations. The following examples illustrate possible uses of these features:

Automatically start a quality control process, based on predefined criteria (upon warehouse registration of a

purchase order from a specific vendor).

Block inventory during inspection to prevent non-approved inventory from being used (full blocking of

purchase order quantities).

Use item sampling as part of a quality association to define the amount of current physical inventory that

must be inspected. Sampling can be based on fixed quantities, a percentage, or full license plate.

The Quality management for warehouse processes feature extends the capabilities of quality management. If you are

using this feature, then see Quality management for warehouse processes for examples of how quality management

works when it's enabled.

Create quality orders for partial receipts. To create a quality order that is based on the quantity that is

physically received with an order, you must select the Per updated quantityPer updated quantity  check box on the ItemItem

samplingsampling form.

Create test types that include minimum, maximum, and target test values, and perform qualitative-versus-

quantitative testing that has predefined validation results.

Specify an acceptable quality level (AQL) to control quality measure tolerances.

Specify the resources that an inspection operation requires, such as a test area and test instruments.

The business process that uses a quality association can be related to various source documents, such as

purchase orders, sales orders, or production orders.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/enable-quality-management.md
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Inventory Not applicable Not applicable None All

Sales Picking process is
scheduled

Before None Specific ID, Group, or
All only

Picking process

Packing slip

Invoice

Packing slip Before None

Packing slip

Invoice

Purchase Receipt list Before None

Receipt list

Product receipt

Invoice

After None

Product receipt

Invoice

Registration Not applicable None

Product receipt

Each quality association record defines the set of tests, the AQL, and the sampling plan that applies to the quality

orders that are generated. You must define a quality association record for each variation in a business process.

For example, you can set up a quality association that generates a quality order when a purchase order product

receipt is updated. Depending on the setup of the execution plan, the triggering process itself can be blocked

while there is an open quality order, or the next processes, such as purchase order invoicing, can be blocked.

Note:Note: While there are open quality orders, inventory quantities are automatically blocked from being issued.

Depending on the Full blockingFull blocking setting on the Item samplingsItem samplings  page, the quantity is either the quantity on the

quality order or the quantity on the source document line.

For a given business process, the quality association record identifies the event and the conditions that a quality

order is generated for. The conditions can be specific to either a site or a legal entity. A quality order that involves

destructive tests can be generated only when on-hand inventory exists for the event.

The following examples illustrate how a quality association record is defined for the variations in each business

process. For each example, the following table summarizes the events and conditions that are defined by a

quality association record.



Invoice

Product receipt Before None

Product receipt

Invoice

After None

Invoice

Production Registration Not applicable None All

Report as finished

End

Report as finished Before None

Report as finished

End

After None

End

Quarantine Report as finished Before Report as finished

End

After End

End Before End

Route operation Report as finished Before None Specific ID, Group, or
All, and Resource
specific, Group, or All

Report as finished

After None

Co-product
production

Registration Not applicable None All

Report as finished Before

After

The following table provides more information about how quality orders can be generated for specific types of

processes.
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Purchase order Before or after a
receipts list or
product receipt for
the material that is
received is posted

After the product
receipt for the
material that is
received is posted,
because the material
must be available for
destructive testing

The requirement for
a quality order can
reflect a particular
site, item, or vendor,
or a combination of
these conditions.

A manually
generated quality
order that refers to a
purchase order can
use information in a
quality association
record, such as the
test sampling plan.

Quarantine order Before or after the
quarantine order is
reported as finished
or ended

Quality orders that
require destructive
tests can't be
generated. It's
assumed that the
quarantine order
functionality handles
the disposition of the
material that is
destroyed.

The requirement for
a quality order can
reflect a particular
site, item, or vendor,
or a combination of
these conditions.

A manually
generated quality
order that refers to a
quarantine order can
use information in a
quality association
record, such as the
test sampling plan.

Sales order Before a scheduled
picking process or
packing slip update
for the items that are
being shipped

At any step The requirement for
a quality order can
reflect a particular
site, item, or
customer, or a
combination of these
conditions.

A manually
generated quality
order that refers to a
sales order can use
information in a
quality association
record, such as the
test sampling plan.

Production order Before or after the
finished quantity for
the production order
is reported

After the finished
quantity for the
production order is
reported

The requirement for
a quality order can
reflect a particular
site or item, or a
combination of these
conditions.

A manually
generated quality
order that refers to a
production order can
use information in a
quality association
record, such as the
test sampling plan.

Production order
that has a route
operation

Before or after the
report is finished for
an operation

After the reporting
production is finished
for the last operation

The requirement for
a quality order can
reflect a particular,
site, item, or
operations resource,
or a combination of
these conditions.

A manually
generated quality
order that refers to a
route operation can
use information in a
quality association
record, such as the
test sampling plan.

Inventory A quality order
cannot be
automatically
generated for a
transaction in an
inventory journal or
for transfer order
transactions.

A quality order must
be created manually
for an item's
inventory quantity.
Physical on-hand
inventory is required.



Quality order auto-generation examples
PurchasingPurchasing

ProductionProduction
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Percentage: 10% Yes

In purchasing, if you set the Event typeEvent type field to Product receiptProduct receipt and the ExecutionExecution field to AfterAfter  on the

Quality associationsQuality associations  page, you get the following results:

If the Per updated quantityPer updated quantity  option is set to YesYes , a quality order is generated for every receipt against the

purchase order, based on the received quantity and settings in the item sampling. Every time that a quantity

is received against the purchase order, new quality orders are generated based on the newly received

quantity.

If the Per updated quantityPer updated quantity  option is set to NoNo, a quality order is generated for the first receipt against the

purchase order, based on the received quantity. Additionally, one or more quality orders are created based on

the remaining quantity, depending on the tracking dimensions. Quality orders aren't generated for

subsequent receipts against the purchase order.

In production, if you set the Event typeEvent type field to Repor t as finishedRepor t as finished and the ExecutionExecution field to AfterAfter  on the

Quality associationsQuality associations  page, you get the following results:

If the Per updated quantityPer updated quantity  option is set to YesYes , a quality order is generated based on every finished

quantity and settings in the item sampling. Every time that a quantity is reported as finished against the

production order, new quality orders are generated based on newly finished quantity. This generation logic is

consistent with purchasing.

If the Per updated quantityPer updated quantity  option is set to NoNo, a quality order is generated the first time that a quantity is

reported as finished, based on the finished quantity. Additionally, one or more quality orders are created

based on the remaining quantity, depending on the tracking dimensions of the item sampling. Quality orders

aren't generated for subsequent finished quantities.

Batch number: No

Serial number: No

Order quantity: 100

1. Report as finished
for 30

2. Report as finished
for 70

Quality order
#1 for 3
(10% of 30)

Quality order
#2 for 7
(10% of the
remaining
order
quantity,
which equals
70 in this
case)



Fixed quantity: 1 No Order quantity: 100Batch number: No

Serial number: No
1. Report as finished

for 30

2. Report as finished
for 10

3. Report as finished
for 60

Quality order
#1 for 1 (for
the first
reported-as-
finished
quantity,
which has a
fixed value of
1)

Quality order
#2 for 1 (for
the
remaining
quantity,
which still
has a fixed
value of 1)

No quality
orders are
created.

No quality
orders are
created.



Fixed quantity: 1 Yes Batch number: Yes

Serial number: Yes

Order quantity: 10

1. Report as finished
for 3: 1 for #b1, #s1;
1 for #b2, #s2; and
1 for #b3, #s3

2. Report as finished
for 2: 1 for #b4, #s4;
and 1 for #b5, #s5

Quality order
#1 for 1 of
batch #b1,
serial #s1

Quality order
#2 for 1 of
batch #b2,
serial #s2

Quality order
#3 for 1 of
batch #b3,
serial #s3

Quality order
#4 for 1 of
batch #b4,
serial #s4

Quality order
#5 for 1 of
batch #b5,
serial #s5

Note:Note:  The batch can be
reused.



Fixed quantity: 2 No

NOTENOTE

Quality management pages
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Batch number: Yes

Serial number: Yes

Order quantity: 10

1. Report as finished
for 4: 1 for #b1, #s1;
1 for #b2, #s2; 1 for
#b3, #s3; and 1 for
#b4, #s4

2. Report as finished
for 6: 1 for #b5, #s5;
1 for #b6, #s6; 1 for
#b7, #s7; 1 for #b8,
#s8; 1 for #b9, #s9;
and 1 for #b10,
#s10

Quality order
#1 for 1 of
batch #b1,
serial #s1

Quality order
#2 for 1 of
batch #b2,
serial #s2

Quality order
#3 for 1 of
batch #b3,
serial #s3

Quality order
#4 for 1 of
batch #b4,
serial #s4

Quality order
#5 for 2,
without a
reference to
a batch and
a serial
number

No quality
orders are
created.

The Quality management for warehouse processes feature adds capabilities for quality order processing for production

with Event typeEvent type set to Report as finished and ExecutionExecution set to After, and for purchases with Event typeEvent type set to

Registration. For details, see Quality management for warehouse processes.



Quality associations See the previous sections of this
article.

A quality association defines all the
following information for a quality
order that is generated:

You must define a quality association
for each variation in a business process
that requires automatic generation of
quality orders. For example, a quality
order can be generated in the business
processes for purchase orders,
quarantine orders, sales orders, and
production orders.

Tests Use this page to define and view the
individual tests that determine
whether your products meet quality
specifications. You can assign one or
more individual tests to a test group.
In this case, you also specify test-
specific information, such as the
acceptable measurement values.
Measurement values are used for
quantitative tests, and test variables
are used for qualitative tests.

A manufacturing company performs
two tests on purchased material: a
quantitative test about material quality
and a qualitative test about packaging
damage. The company defines
additional information about the
qualitative test to identify the test
variable (damaged packaging) and its
outcomes. The company uses the TestTest
groupsgroups page to assign the two tests
to a test group and to specify the test-
specific information. The test group is
assigned to a quality order, so that the
company can report test results for
the two tests.

PA GEPA GE DESC RIP T IO NDESC RIP T IO N EXA M P L EEXA M P L E

The transaction event

The set of tests that must be
performed on the items

The AQL

The sampling plan

A quantitative test has a test
type of IntegerInteger  or FractionFraction,
and also has a designated unit
of measure. Quality
specifications and test results
are expressed as numbers.

A qualitative test has a test
type of OptionOption. Qualitative
tests require additional
information about the test
variable that is being measured
and its enumerated options.
Quality specifications and test
results are expressed according
to an outcome.



Test groups Use this page to set up, edit, and view
test groups and the individual tests
that are assigned to a test group. The
upper pane displays test groups, and
the lower pane displays the tests that
are assigned to a selected test group.
You assign several policies to a test
group, such as a sampling plan, an
AQL, and the requirement for
destructive testing. When you assign
an individual test to a test group, you
define additional information, such as
the sequence, documents, and validity
dates. For a quantitative test, the
information that you define also
includes the acceptable measurement
values. For a qualitative test, the
information includes the test variable
and default outcome. The test group
that is assigned to a quality order
defines the default set of tests that
must be performed on the specified
item. However, you can add, delete, or
change tests on the quality order. Test
results are reported for each test on a
quality order.

A manufacturing company defines a
test group for each variation of its
quality guidelines. The various test
groups reflect differences in the
sampling plans, the sets of tests that
must be performed together, the AQL,
and other factors. For quantitative
tests, there are also differences in the
acceptable measurement values. To
enforce its quality guidelines, the
company assigns a test group to each
rule for automatically generating
quality orders on the QualityQuality
associationsassociations page, and also assigns a
test group to quality orders that are
manually created.

Item quality groups Use this page to set up, edit, and view
the items that are assigned to a quality
group or the quality groups that are
assigned to an item. A quality group
represents common testing
requirements for items. After you
define the test requirements on the
Test groupsTest groups page, you can define the
rules for automatically generating
quality orders. To simplify the process,
you don't define rules for individual
items. Instead, you define rules for a
quality group, by using the QualityQuality
associationsassociations page. You can also use
the Item quality groupsItem quality groups page for a
selected quality group to assign
relevant items to that group. You can
also use the Item quality groupsItem quality groups
page for a selected item to assign
relevant quality groups to that item.

A manufacturing company purchases
various raw materials that have the
same testing requirements for
incoming inspection. The company
defines a quality group and then
assigns the item numbers that are
associated with the raw materials to
that group. Later, the company
purchases a new type of raw material
that has the same testing
requirements. Instead of setting up
new testing requirements for the new
material, the company adds the item
number for the new material to the
existing quality group. The same
manufacturing company also produces
items that have the same production
testing requirements and ships items
that have the same requirement for
pre-shipment testing. The company
defines two additional quality groups
and then assigns the relevant item
numbers to each group.
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Test variables Use this page to define and view the
variables that are associated with a
qualitative test. For each variable, you
define enumerated outcomes that
represent the possible options. You
define tests on the TestsTests  page. For
qualitative tests, you must set the test
type to OptionOption. Use the Test groupsTest groups
page to assign a test variable to an
individual test.

A manufacturing company that
produces cookies uses an inspection
test for the finished product. This
inspection test has several variables.
One variable is taste, and the possible
outcomes for this variable are good
and bad. A second variable is color,
and the possible outcomes are too
dark, too light, and correct.

Test variable outcomes Use this page to set up, edit, and to
view the possible test results for a test
variable that is associated with a
qualitative test. For each outcome, you
assign a passpass or failfail status. You must
define a variable and its outcomes for
each qualitative test that is defined on
the TestsTests  page. (For qualitative tests,
the test type is set to OptionOption on the
TestsTests  page.) Use the Test groupsTest groups
page to assign a test variable and the
default outcome to an individual
qualitative test.

A manufacturing company that
produces cookies uses an inspection
test for the finished product. This
inspection test has of several variables.
One variable is taste, and the possible
outcomes for this variable are good
and bad. A second variable is color,
and the possible outcomes are too
dark, too light, and correct. A status of
passpass or failfail is assigned to each
outcome. During the inspection test
for each variable, the inspector reports
the test result by selecting one of the
outcomes.
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Controlling the quality management process

This article provides information about the quality management process for nonconforming products. It

describes how you can use quality control functionality, how to define and maintain nonconformances, and how

to handle corrections.

Quality assurance involves product testing and the management of nonconforming material. Quality

management processes help guarantee a high level of product quality in your supply chain. These processes

also help optimize supply chain processes and increase customer satisfaction. Quality management can help

you manage turnaround times when you're dealing with nonconforming products, regardless of point of origin

of those products. You can link diagnostic results to correction tasks. The system can schedule tasks to correct

problems and therefore help prevent recurrences of those problems in the future. Quality management also lets

you track issues (including internal problems) by problem type, and lets you identify solutions as either short-

term or long-term. Statistics about key performance indicators (KPIs) provide insight into nonconformance

problems that have previously occurred and the solutions that were applied to correct them. You can use

historical data to help review the effectiveness of quality measures that have previously been taken and to

determine appropriate measures in the future.

Here are some of the ways that you can control the quality management process:

Create quality orders that are based on trigger points such as “at product receipt” for inbound operations or

“at product pick-up” for outbound operations.

Document test results, and determine whether the results meet the established test criteria and acceptable

quality levels.

Use document management for detailed product specifications and user-specific notes as part of reporting

during the inspection process.

Maintain nonconforming products, and correlate these products with additional nonconformance

information to track down the original cause of a problem.

Document the cost of managing a nonconformance. This cost can include the items (such as spare parts),

miscellaneous charges, and the timesheet hours that are required in order to correct the nonconformance.

Schedule error correction processes by using correction handling that is linked to quality orders.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/quality-management-processes.md


Product testing and quality orders

Nonconformance

Product testing is typically referred to as quality control and uses quality orders. By using the quality control

functionality, you can do the following:

Define the tests that must be performed for material. These tests include the quality specifications, the

applicable test instrument, documents that describe the test, a sampling plan, and the acceptable quality

levels (AQL).

Create a quality order that identifies the tests that must be performed for a specific order, such as a purchase

or production order, or for a specific inventory quantity. You can create a quality order manually or generate

a quality order automatically, based on quality guidelines.

Define the quality guidelines that are related to purchase, quarantine, production, or sales orders in each

business process, so that a quality order can be automatically generated that identifies the testing

requirements for incoming or outgoing material.

Record the test results in a quality order, validate the test results against the AQL, and print a certificate of

analysis that displays the test results.

A nonconformance describes an item that has a quality problem. The nonconformance process lets you create a

nonconformance order that describes a quantity of nonconforming material, the problem source, the problem

type, and explanatory notes. You can define a classification of problem types to make analysis of nonconforming

material easier. You can also print a nonconformance tag and a nonconformance report to guide the disposition

of nonconforming material. For example, the tag and report might indicate a condition of UnusableUnusable or

Restr icted usageRestr icted usage.

The following table lists the six default nonconformance types and describes the information that must be

recorded for each type.

file:///T:/eiye/ac1a/dynamics365/supply-chain/inventory/media/quality-management-process-diagram.png
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Customer The customer account number, the sales order number, or a
lot number of a sales order transaction. For example, the
nonconformance might be related to a specific sales order
shipment or to customer feedback about product quality.

Service request The customer account number, the sales order number, or a
lot number of a sales order transaction. For example, the
nonconformance might be related to a specific sales order
shipment or to a customer's complaint about item quality.

Vendor The vendor account number, the purchase order number, or
a lot number of a purchase order transaction. For example,
the nonconformance might be related to a purchase order
receipt or to a vendor's concern about a part that it supplies.

Production The production order number or a lot number of a
production order transaction. For example, the
nonconformance might be related to a specific batch that
was produced.

Internal The quality order number or a lot number of a quality order
transaction. For example, the nonconformance might be
related to the tests that are performed as part of a quality
order or to an employee's concern about product quality.

Co-product production A co-product production order nonconformance that is
related to batch production orders.

Approved nonconformance

Nonconformances are associated with a problem type. Problem types are defined on the Problem typesProblem types  page,

where you specify which problem types can be associated with each nonconformance type. For example, the

problem types for nonconformances of the Ser vice requestSer vice request type might reflect a classification of customer

complaints, whereas the problem types for nonconformances of the **Internal **type might represent a

classification of defect codes.

When you create a new nonconformance, you select the nonconformance type and the problem type. The initial

approval status is NewNew , which represents a request for action. The next step is to change the approval status to

ApprovedApproved or RefusedRefused, to indicate that you will or won't take action on the nonconformance. You can also close

a nonconformance (by selecting a separate check box) to indicate that you're finished with it, or you can reopen

a nonconformance to indicate that additional consideration is required.

You can enter comments for a nonconformance by attaching a document. It's a good idea to define a unique

document type for nonconformances by using the Document typeDocument type page. You can then use the Repor t setupRepor t setup

page to define whether comments for this document type should be printed on the nonconformance report and

nonconformance tag. The conformance report and nonconformance tag can help with material disposition. You

can selectively generate reports and tags, based on selection criteria that are associated with a nonconformance.

These criteria include the nonconformance number, item, customer, vendor, and status.

The nonconformance report displays the nonconformance number, item, and problem type. Depending on your

report setup policy, the report might also display related notes about the nonconformance. The

nonconformance tag displays similar information, and also includes the quarantine zone and type (such as

Restr icted usageRestr icted usage or UnusableUnusable) that you assigned to the nonconformance to help guide disposition of the

defective material.



Correction handling

Additional resources

NOTENOTE

You can optionally define one or more related operations for an approved nonconformance. A related operation

describes the work that should be performed, and contains a list of the quality operations that you've defined

and descriptive text about the reason for the work. After you define an operation, you can optionally define the

miscellaneous charges, items, and timesheet labor hours that are required in order to perform the work. The

calculated costs are shown for the related operation, and the total calculated costs are shown for the

nonconformance. The calculated costs and the underlying details (about items, labor hours, and miscellaneous

charges) represent reference information, and they are used only in the quality management function.

You can optionally create a quality order from a nonconformance by first performing an inquiry for quality

orders and then creating the new quality order. For example, a quality order might identify the need to test (or

retest) the defective material. The newly created quality order displays the link to the originating

nonconformance.

You can optionally link one nonconformance to another and create a new nonconformance from an existing one.

For example, the link can reflect the interconnection between quality problems.

The CorrectionsCorrections  page lets you create a list of nonconformances that must be corrected. Each correction item is

associated with the diagnostic type that caused the problem to be discovered. The CorrectionsCorrections  page also

contains information about who must perform a corrective action, and when. You can describe the details of the

problem and the corrective action that is required by attaching a document to the correction. After the

nonconformance has been addressed or corrected, you "close" the correction item by selecting the CompletedCompleted

option. You can also indicate that the solution was a short-term solution.

It's a good idea to define a unique document type for corrections by using the Document typeDocument type page. You can

then use the Repor t setupRepor t setup page to define whether comments for this document type are printed on the

correction report. A printed correction report displays information about the nonconformance and the related

nonconformance notes. The report also includes correction information, such as the diagnostic type, and the

related correction notes.

Quality management overview

Nonconformance management

Inventory blocking

Quarantine orders

Set up quality orders

Inspect the quality of goods

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Turn on the Quality management for warehouse processes feature

Key benefits

NOTENOTE

Quality management and the Quality management for warehouse
processes feature

The Quality management for warehouse processes feature lets you integrate item sampling controls into the

warehouse receiving process by using advanced warehouse management. Warehouse work can be

automatically generated to move inventory to the quality control location, based on a percentage or a fixed

quantity, or based on every nth license plate. After a quality order has been completed, work can be

automatically generated to move inventory to the next location in the process, depending on the quality results.

The Quality management for warehouse processes feature extends the capabilities of the basic quality

management feature. It provides the option to create quality orders for the inventory that is sent to the quality

control location, although quality orders aren't always required. Therefore, it allows for a lightweight quality

control process that is based on warehouse work.

Before you can use this feature, it must be turned on in your system. Admins can use the feature management

settings to check the status of the feature and turn it on. In the Feature managementFeature management workspace, the feature is

listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Quality management for warehouse processes

The Quality management for warehouse processes feature automatically generates work as part of the receiving

process, to move the inventory quantity that is required for quality control to a quality control location. If the

quantity that is received exceeds the quantity that is required for quality control (according to the item sampling

setup), the excess quantity is moved to an inbound location that is defined in the location directive setup. After

the quality order is validated, work is automatically generated to move the quantity for the quality order to a

new inbound or return location, based on the validation result and the location directive setup. The automatic

generation of work that has only the quantity that must be moved to and from quality control provides an

integrated process experience.

When the Quality management for warehouse processes feature is turned on, you can still take advantage of the manual

process. In the manual process, inventory movement and movement by template are used to have a warehouse worker

trigger the creation of warehouse work to move inventory from a quality control location to a new location. You can also

still set up an inbound location directive that moves inventory in its entirety from a receiving location to a quality control

location without considering the item sampling setup.

When the Quality management for warehouse processes feature is turned on, it changes the setup of key

warehouse management and quality management entities. The following illustration provides an overview of

the entities that enable quality orders for warehouse processes. Text in parentheses indicates suggested actions

when quality management was applied before the Quality management for warehouse management processes

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/quality-management-for-warehouses-processes.md


Enablers: The Quality item sampling and Quality order work order
types

Work classes, location directives, and work templatesWork classes, location directives, and work templates

Enable a warehouse for quality management

feature was turned on.

The Quality management for warehouse processes feature introduces two work order types that enable the

work creation process:

Quality item samplingQuality item sampling – This work order type is used to create work that moves registered inventory to

quality control.

Quality orderQuality order  – This work order type is used to create work that moves inventory from quality control to a

new location, based on the location directive setup.

The Quality item sampling and Quality order work order types are consumed by location directives, work

classes, and work templates.

Before warehouse work can be automatically generated to move inventory to quality control, you must follow

these steps to set up your system.

1. Create separate work classes for the Quality item sampling and Quality order work order types. In this

way, you ensure that appropriate work can be automatically generated based on the two work order

types, and that this work can then be run by using the warehouse app.

2. Set up a work template for each work order type:

Set up a work template that uses the Quality item sampling work order type to automatically move

registered inventory to a quality control location.

Set up a work template that uses the quality order work order type to move inventory from a quality

control location after quality control is completed.

3. For each work order type, set up location directives that apply the correct quality control locations that

the inventory should be moved to. After quality control is completed, the location directive for the Quality

order work order type ensures that a new destination location will be selected so that the inventory can

be moved out of the quality control location.

4. Set up the relevant mobile device menu items to support the movement of received inventory to the

quality control location, and the movement of inventory that passes or fails quality control from the

quality control location to a new location.

For a step-by-step example that shows how to complete this setup, see the example scenario at the end of this

topic.

Before the Quality management for warehouse processes feature can be applied for a specific warehouse, you

must follow these steps to make the feature available for that warehouse.



Quality control

Quality associationsQuality associations
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Group 1 For each quality association, check the Reference typeReference type,
Event typeEvent type, and Execution matchExecution match values against the item.
If there is a match against the source document line, move
on to group 2.

1. Go to Warehouse management > Setup > Warehouse > WarehousesWarehouse management > Setup > Warehouse > Warehouses .

2. Select the warehouse to enable for quality management.

3. On the WarehouseWarehouse FastTab, set the Enable quality order for warehouse processesEnable quality order for warehouse processes  option to Yes. (Note

that this option can be set to Yes only for warehouses that use warehouse management processes.)

When the Enable quality order for warehouse processesEnable quality order for warehouse processes  option is set to Yes, the quality association setup

controls whether the Quality management for warehouse processes feature is actually applied for the selected

warehouse. You can change the setting of the option to No at any time. In that case, the feature will no longer

apply for the warehouse, regardless of the quality association setup.

The Quality management for warehouse processes feature controls several key settings for quality associations

and item sampling.

Each quality association record defines the set of tests, the acceptable quality level (AQL), and the sampling plan

that apply to the quality orders that are generated. To set up a quality association record, follow these steps.

1. Go to Inventor y management > Setup > Quality control > Quality associationsInventor y management > Setup > Quality control > Quality associations .

2. Create or select the quality association entry for the item or group that you're working with, or for all

items.

3. On the ConditionsConditions  FastTab, set the Applicable warehouse typeApplicable warehouse type field to one of the following values:

Quality management for warehouse processes onlyQuality management for warehouse processes only  – Activate the Quality management for

warehouse processes feature. You can select this value only if the reference type is either Purchase or

Production.

AllAll  – Inactivate the Quality management for warehouse processes feature. Select this value for all

reference types except Purchase and Production.

The Quality management for warehouse processes feature takes effect only if the item on the source document line uses

advanced warehouse management processes, and if the Enable quality order for warehouse processesEnable quality order for warehouse processes option is set

to Yes for the warehouse on the source document line.

As each item is registered (or reported as finished), the system determines which quality associations apply to it.

When the Quality management for warehouse processes feature is turned on, the applicable warehouse type is

logically inserted into the fourth search group of the quality association search hierarchy. The following table

provides a logical representation of the search hierarchy.



Group 2 For each quality association, check the Item codeItem code value
(Table, Group, or All) against the item. Table is more specific
than Group, and Group is more specific than All. If there is a
match for Table (a specific item), move on to group 3. If there
is no match for Table, search for a match for Group. If there
is no match for Group, All applies. If there is a match, move
on to group 3.

Group 3 For each quality association, check the Account codeAccount code and
Resource codeResource code values against the item. The logic that is
applied resembles the logic that is applied for the ItemItem
codecode value.

Group 4 For each quality association, check the ApplicableApplicable
warehouse typewarehouse type value (Quality management for
warehouse processes only or All) against the item. If the
Enable quality order for warehouse processesEnable quality order for warehouse processes option
is set to Yes for the warehouse on the source document, and
the item on the source document line is set to Use
warehouse management processes, both associations where
there is a match for Quality management for warehouse
processes only and associations where there is a match for
All will be applicable in parallel, if both exist. If the EnableEnable
quality order for warehouse processesquality order for warehouse processes option is set to
No for the warehouse on the source document, and the item
on the source document line is set to Use warehouse
management processes, only quality management will be
applicable.

SEA RC H  GRO UPSEA RC H  GRO UP DESC RIP T IO NDESC RIP T IO N
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Reference typesReference types

For example, you've defined a warehouse where the Enable quality order for warehouse processesEnable quality order for warehouse processes  option

is set to Yes, and you have two quality associations that are defined for the Purchase reference type: one for all

items and one for the Registration event type. The only difference between the two quality associations is the

Applicable warehouse typeApplicable warehouse type value: it's set to All for one quality association and Quality management for

warehouse processes only for the other. In this case, both quality associations are equally specific, and both will

be applicable.

The value of the Test groupTest group field for the quality associations is also a factor. This field defines the test procedure

that must be applied. If the Test groupTest group value is the same for both associations, only one quality order will be

created, for the quality association where the Applicable warehouse typeApplicable warehouse type value is Quality management for

warehouse processes only. If the Test groupTest group value isn't the same for both associations, two quality orders will

be created. The first quality order will be created for the quality association where the Applicable warehouseApplicable warehouse

typetype value is Quality management for warehouse processes only. The second quality order will be created for

the quality association where the Applicable warehouse typeApplicable warehouse type value is All.

The Quality management for warehouse processes only value is considered more specific than All when the criteria for the

quality associations for groups 1 and 2 are the same, and when the test group is the same. Two quality orders will be

created only when the test groups differ.

When the Reference typeReference type value is Purchase, and the Applicable warehouse typeApplicable warehouse type value is Quality

management for warehouse processes only, the Event typeEvent type field on the ProcessProcess  FastTab must be set to

Registration. Registration is the only supported event type for the Purchase reference type when you are using

the Quality management for warehouse processes feature.



Quality processing policyQuality processing policy

NOTENOTE

Referenced item samplingReferenced item sampling

NOTENOTE

Item samplingItem sampling

The Quality management for warehouse processes feature enables work to be created based only on item

sampling. Therefore, it allows for a lightweight process. The inventory that work is created depends on the item

sampling that is associated with the quality association. When the lightweight process is used, after a worker

puts the quantity in the quality control location, the quality department can manually create a quality order, if a

quality order is required.

The Quality processing policyQuality processing policy  field on the Quality order processQuality order process  FastTab controls whether a quality order

is also created when work is created to move an item to the quality control location. This field can be set to

Create quality order or Create work only. The default value is Create quality order.

Regardless of whether you create quality orders manually or automatically, the system automatically generates work to

move items out of the quality control location when the quality order is marked as validated.

The creation of quality order work is unrelated to the quality association setup. If a work template exists that has

a Work order typeWork order type value of Quality order, and if the query criteria are met for that work template, validation of

a quality order will trigger the creation of quality order work.

Each quality association must reference an item sampling. An item sampling defines the quantity that will be

sent for quality control. It can be set up so that it applies only to quality associations where the ApplicableApplicable

warehouse typewarehouse type value is Quality management for warehouse processes only. If the Sampling scopeSampling scope value for

an item sampling is Load or Shipment, or the Quantity specificationQuantity specification value is Full license plate, the item

sampling can be referenced only by quality associations where the Applicable warehouse typeApplicable warehouse type value is

Quality management for warehouse processes only.

If you define an item sampling that uses the Quality management for warehouse processes only applicable

warehouse type, you will receive an error if you try to reference it from a quality association that doesn't use the

Quality management for warehouse processes feature.

Item sampling that uses full blocking isn't supported for quality associations where the Applicable warehouse typeApplicable warehouse type

field is set to Quality management for warehouse processes only.

Item sampling controls how often items are sent for quality control. The Quality management for warehouse

processes feature introduces the concept of item sampling scope. The system uses the item sampling scope

when it evaluates whether and how quality orders and/or quality item sampling work and quality order work

should be created.

To set up item sampling, go to Inventor y management > Setup > Quality control > Item samplingInventor y management > Setup > Quality control > Item sampling, and

set the Sampling scopeSampling scope field to one of the following values:

OrderOrder  – The source document line will be the basis for evaluating whether and how quality orders and/or

quality item sampling work and quality order work are created. This value is the default value, and when it's

selected, the system works the same way that it works when the Quality management for warehouse

processes feature isn't turned on.

LoadLoad – Loads will be used as the basis for evaluating whether and how a quality order and/or work is

created. This value is available only when the Quality management for warehouse processes feature is turned

on.

ShipmentShipment – Shipments will be used as the basis for evaluating whether and how a quality order and/or
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Examples of automatic generation of quality orders
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work is created. This value is available only when the Quality management for warehouse processes feature

is turned on.

When the Sampling scopeSampling scope field is set to Load or Shipment, the load entity and shipment entities will be used, if they are

available. If they aren't available, the order entity will be used.

The Quality management for warehouse processes feature also introduces the Full license plate value for the

Quantity specificationQuantity specification field. This value supports the creation of quality order work and quality item sampling

work, based on license plates. When you select this value, the following changes occur :

The Break count by itemBreak count by item option and the Per nth license platePer nth license plate field on the ProcessProcess  FastTab become

available.

The ValueValue field on the Sampling quantitySampling quantity  FastTab becomes unavailable.

The Per updated quantityPer updated quantity , LocationLocation, and L icense plateLicense plate options are all set to Yes, and the settings can't be

changed.

The Break count by itemBreak count by item option controls whether the license plate count is evaluated per item or across all

items in the sampling scope. Product variants are treated as the same item. This option also controls whether

the license plate count is reset for each item.

The value of the Per nth license platePer nth license plate field controls how often quality orders are created in relation to the

number of items that are registered. For example, a value of 3 will send every third item to quality control,

starting with the first item. The value must be more than 0 (zero).

While workers receive items by using the warehouse app, the system validates whether a quality association is

set up for each incoming item. If a quality association is set up, the system uses the item sampling record that is

configured for that quality association to determine how it will create quality orders, quality item sampling

work, and purchase order work.

When receipt registration is done in the web client (by using the small registration page or the item arrival journal for

purchase order lines), no quality item sampling work or purchase order work will be created, regardless of the setup.

Instead, for items that match a quality association, the referenced item sampling will be used to control the creation of

quality orders only.

The following examples show how the setup of a quality association and an associated item sampling affects the

generation of quality orders when the Applicable warehouse typeApplicable warehouse type field is set to Quality management for

warehouse processes only.

When the Quantity specificationQuantity specification value is Full license plate, the Per nth license platePer nth license plate field controls which

license plates quality item sampling work is created for. The first license plate always goes to quality control, and

then the value of this field specifies that every nth license plate after that license plate should also go.

The Reference typeReference type value for the following examples is Purchase, and the Event typeEvent type value is Registration.

Location: OrderOrder
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Yes No Not applicable
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Order Percent = 10 No No Not applicable
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Load Percent = 5 Yes
(locked/not
editable)

No Not applicable

SA M P L IN GSA M P L IN G
SC O P ESC O P E

Q UA N T IT YQ UA N T IT Y
SP EC IF IC AT IOSP EC IF IC AT IO
NN

P ER UP DAT EDP ER UP DAT ED
Q UA N T IT YQ UA N T IT Y

P ER STO RA GEP ER STO RA GE
DIM EN SIO NDIM EN SIO N

B REA KB REA K
C O UN T  B YC O UN T  B Y
IT EMIT EM

P ER N T HP ER N T H
L IC EN SEL IC EN SE
P L AT EP L AT E RESULTRESULT

LP2

Pu
rc
ha
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de
r
w
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k
for
50
EA
(p
ut
-
aw
ay
)

Location:
No

License
Plate: No

OrderOrder
lineline
quantityquantity
: 500 EA: 500 EA

TwoTwo
loads:loads:
firstfirst
load 200load 200
EA ,EA ,
secondsecond
load 300load 300
EAEA

1. Regist
er
receipt
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wareh
ouse
app
for
first
load
for
100
EA

Q
ua
lit
y
ite
m
sa
m
pli
ng
w
or
k
for
5
EA
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-
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for
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de
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for
5
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Pu
rc
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k
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-
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)

Q
ua
lit
y
ite
m
sa
m
pli
ng
w
or
k
for
15
EA

Q
ua
lit
y
or
de
r 1
for
15
EA



Order Percent = 10 No No Not applicable
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5
EA
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-
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Plate: Yes

OrderOrder
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1. Regist
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Q
ua
lit
y
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m
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m
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w
or
k
for
5
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Q
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y
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r 1
for
5
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-
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ay
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m
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w
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k
for
5
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Q
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y
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de
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5
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Pu
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Load Full license
plate

Yes
(locked/not
editable)

No 3
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w
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k
for
45
(p
ut
-
aw
ay
)

Location:
Yes

License
Plate: Yes
(locked/n
ot
editable)

TwoTwo
items:items:

OrderOrder
lineline
quantquant
ityity
forfor
itemitem
A:A:
120120
EA (4EA (4
palletpallet
s)s)

OrderOrder
lineline
quantquant
ityity
forfor
itemitem
B: 90B: 90
EA (3EA (3
palletpallet
s)s)

OneOne
load,load,
two loadtwo load
lineslines
withwith
eacheach
orderorder
lineline

1. Regist
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receipt
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wareh
ouse
app
for
item
A, 30
EA,
LP1

Q
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lit
y
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receipt
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item
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wareh
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for
item
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sa
m
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w
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k
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30
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y
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EA
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de
r
w
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k
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-
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wareh
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receipt
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w
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-
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y
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m
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m
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w
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k
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Q
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lit
y
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EA



SA M P L IN GSA M P L IN G
SC O P ESC O P E

Q UA N T IT YQ UA N T IT Y
SP EC IF IC AT IOSP EC IF IC AT IO
NN

P ER UP DAT EDP ER UP DAT ED
Q UA N T IT YQ UA N T IT Y

P ER STO RA GEP ER STO RA GE
DIM EN SIO NDIM EN SIO N

B REA KB REA K
C O UN T  B YC O UN T  B Y
IT EMIT EM

P ER N T HP ER N T H
L IC EN SEL IC EN SE
P L AT EP L AT E RESULTRESULT

app
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item B,
30 EA,
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receipt
in the
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for
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Pu
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ha
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de
r
w
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k
for
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ut
-
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ay
)

Pu
rc
ha
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de
r
w
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k
for
30
EA
(p
ut
-
aw
ay
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Load Full license
plate

Yes
(locked/not
editable)

Yes 3

SA M P L IN GSA M P L IN G
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EA,
LP7
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y
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m
sa
m
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w
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k
for
30
EA

Q
ua
lit
y
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de
r 1
for
30
EA

Location:
Yes

License
Plate: Yes
(locked/n
ot
editable)

TwoTwo
items:items:

OrderOrder
lineline
quantquant
ityity
forfor
itemitem
A:A:
120120
EA (4EA (4
palletpallet
s)s)

OrderOrder
lineline
quantquant
ityity
forfor
itemitem
B: 90B: 90
EA (3EA (3
palletpallet
s)s)
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load,load,
two loadtwo load
lineslines
withwith
eacheach
orderorder
lineline
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y
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m
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m
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w
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k
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y
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r
w
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k
for
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3. Regist
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4. Regist
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in the
wareh
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app
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-
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Pu
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r
w
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k
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30
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-
aw
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Q
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y
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m
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m
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w
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k
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Q
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y
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Q
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y
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m
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m
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w
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k
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Q
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y
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Load Percent = 10 Yes
(locked/not
editable)

No Not applicable
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ha
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de
r
w
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k
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-
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se
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de
r
w
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k
for
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EA
(p
ut
-
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No

License
Plate: No

OrderOrder
lineline
quantityquantity
: 100 EA: 100 EA

No loadsNo loads
areare
created.created.
OrderOrder
scope isscope is
applied.applied.

1. Regist
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receipt
in the
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Process insights when multiple quality associations coexist
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When a worker validates one of the quality orders that are shown in the previous table, the system

automatically generates quality order work to move inventory from the quality control location to the location

that is defined in the location directive for the Quality order work order type. You can set up any location for this

purpose, such as a return or storage location, depending on the test result for the quality order. For an example

of this setup, see the example scenario at the end of this topic.

You can reopen a quality order that has already been validated, provided that the quality order work that is

related to moving the inventory from the quality control location doesn't have a Work statusWork status  value of Closed

or In progress.

More than one quality associations can be defined for and applied to the same source document line, and the

Applicable warehouse typeApplicable warehouse type field can be set to Quality management for warehouse processes only for some

of those quality associations and All for others.



In the following example, the Reference typeReference type value is Purchase.

1. The first quality association is set up in the following way:

Applicable warehouse type:Applicable warehouse type: Quality management for warehouse processes only

Item code:Item code: A0001

Account code:Account code: All

Test group:Test group: Enclosure

Item sampling:Item sampling: 5 pcs

2. The second quality association is set up in the following way:

Applicable warehouse type:Applicable warehouse type: All

Item code:Item code: All

Account code:Account code: All

Test group:Test group: Enclosure

Item sampling:Item sampling: 1 pcs

3. The third quality association is set up in the following way:

Applicable warehouse type:Applicable warehouse type: Quality management for warehouse processes only

Item code:Item code: All

Account code:Account code: 104

Test group:Test group: Impedance

Item sampling:Item sampling: Every second license plate (This setting means that the first, third, fifth, and so on,

license plates that are received will create a quality order.)

4. The fourth quality association is set up in the following way:

Applicable warehouse type:Applicable warehouse type: All

Item code:Item code: All

Account code:Account code: All

Test group:Test group: Impedance

Item sampling:Item sampling: 5 pcs

5. The fifth quality association is set up in the following way:

Applicable warehouse type:Applicable warehouse type: All

Item code:Item code: All

Account code:Account code: All

Test group:Test group: Cone

Item sampling:Item sampling: 10%

A purchase order for a quantity of 10 of item A0001 is now created for vendor 104. Then a purchase order line

that has a quantity of 10 is registered as received on one license plate by using the warehouse app. Here is the

result:

There is one quality order from the first quality association for the Enclosure test group. The quantity is 5.

There is no quality order from the second quality association, because the criteria for the first quality

association are more specific relative to the Enclosure test group.

There is one quality order for the third quality association for the Impedance test group. The quantity is 10.

There is no quality order from the fourth quality association, because the criteria for the first quality

association are more specific relative to the Impedance test group.

There is one quality order for the fifth quality association for the Cone test group. The quantity is 1.

In connection with the creation of one quality order for each of the three quality associations, quality item



NOTENOTE

Canceling quality item sampling work

sampling work is also created. The registered quantity is only 10. However, because of the item sampling setup,

the sum of the quality order quantities that are created for the Quality management for warehouse processes

only applicable warehouse type is 16, which exceeds the physical registered quantity of 10. Therefore, work

won't be created for the full quality order quantities (16), because only 10 are physically available for movement

to the quality control location. The priority that is used to create quality item sampling work follows the order of

quality order creation:

First quality order (quantity = 5):First quality order (quantity = 5): Quality item sampling work is created for 5. A quantity of 5 (10 – 5)

now remains for subsequent creation of quality item sampling work.

Second quality order (quantity = 10):Second quality order (quantity = 10): Quality item sampling work is created for 5. A quantity of 0 (zero)

now remains for subsequent creation of quality item sampling work.

Third quality order (quantity = 1):Third quality order (quantity = 1): No quality item sampling work is created.

As part of the process of creating the quality orders, an inventory blocking of a quantity of 10 is created. This

inventory blocking is referenced against each of the three quality orders. The sum of the quality order quantities

is 16.

When the quality orders are validated, the system tries to create quality order work for each quality order that is

validated. Because the sum of the quality order quantities exceeds the quantity that is actually blocked and

therefore available for work creation, quality order work can't be created for the full quality order quantities, as

shown here. (This example continues the previous example.)

1. Validate the second quality order that is created (quantity = 10). Quality order work isValidate the second quality order that is created (quantity = 10). Quality order work is

created for a quantity of 4 .created for a quantity of 4 .

The creation of quality order work is triggered by a change in the inventory blocking quantity. Because

the sum of quality order quantities was 16, validation of a quantity of 10 will cause the remaining quality

order quantities to be validated as equal to 6. The inventory blocking quantity is reduced from 10 to 6.

The reduced quantity of 4 is allotted to quality order work creation.

2. Validate the first quality order that is created (quantity = 5). Quality order work is createdValidate the first quality order that is created (quantity = 5). Quality order work is created

for a quantity of 5 .for a quantity of 5 .

The creation of quality order work is triggered by a change in the inventory blocking quantity. Because

the sum of quality order quantities was 6, validation of a quantity of 5 will cause the remaining quality

order quantities to be validated as equal to 1. The inventory blocking quantity is reduced from 6 to 1. The

reduced quantity of 5 is allotted to quality order work creation.

3. Validate the third quality order that is created (quantity = 1). Quality order work is createdValidate the third quality order that is created (quantity = 1). Quality order work is created

for a quantity of 1 .for a quantity of 1 .

The creation of quality order work is triggered by a change in the inventory blocking quantity. Because

the sum of quality order quantities was 1, validation of a quantity of 1 will cause the remaining quality

order quantities to be validated as equal to 0 (zero). The inventory blocking is removed (that is, the

inventory blocking quantity is reduced from 1 to 0). The reduced quantity of 1 is allotted to quality order

work creation.

The creation of quality order work depends on the inventory blocking quantity that is referenced against one or more

quality orders. If the sum of the quality order quantities exceeds the referenced inventory blocking quantity, the order

that the quality orders are validated in determines the creation of quality order work.



  

Cross-docking

Destructive testing

Example scenario
Prepare the scenarioPrepare the scenario

Quality-in setup – Move to the quality control locationQuality-in setup – Move to the quality control location

You can cancel the work that is created for quality item sampling. To control what occurs when this work is

canceled, follow these steps.

1. Go to Warehouse management > Setup > Warehouse management parametersWarehouse management > Setup > Warehouse management parameters .

2. On the GeneralGeneral  tab, on the WorkWork FastTab, set the Unregister receipt when cancelling workUnregister receipt when cancelling work option

to one of the following values:

YesYes  – When quality item sampling work is canceled, the associated quality order is deleted, and the

inventory is unregistered.

NoNo – When quality item sampling work is canceled, the associated quality order isn't deleted, and the

inventory isn't unregistered.

You can have a quality association setup that creates item sampling work. However, when cross-docking exists in

parallel with a quality association that creates quality item sampling work, if there is only enough quantity to

satisfy cross-docking, only item sampling work is created. In cases where the Enable quality order forEnable quality order for

warehouse processeswarehouse processes  option set to Yes for the receiving warehouse, and the Applicable warehouse typeApplicable warehouse type

field is set to Quality management for warehouse processes only for a quality association, the creation of quality

item sampling work takes precedence over the creation of cross-docking work. If the quantity exceeds the

requirement for cross-docking, the system still creates only item sampling work.

You can define a test group that performs destructive testing. In the case of a destructive test, the assumption is

that, regardless of the test result, the quantity of the item that is tested will be destroyed as part of the test. The

way that the Quality Management for warehouse processes feature supports destructive testing resembles the

way that quality management supports it when the feature isn't turned on. Before the quality order can be

validated, the quality controller must specify the pick location for the quantity that has been destroyed. You can

register picking from the quality order page by selecting Inventor y > PickInventor y > Pick on the Action Pane. After the pick

for the quality order quantity is registered, validation can be completed.

To work through this scenario, you must prepare your system in the following way:

Make sure that demo data is installed on the system, and select the USMFUSMF legal entity.

Turn on the Quality management for warehouse processes feature in feature management.

Configure warehouse 51 to use the Quality management for warehouse processes feature by following

theses steps:

1. Go to Warehouse management > Setup > Warehouse > WarehousesWarehouse management > Setup > Warehouse > Warehouses .

2. Select warehouse 51.

3. On the WarehouseWarehouse FastTab, set the Enable quality order for warehouse processesEnable quality order for warehouse processes  option to Yes.

You must now prepare a basic setup that will enable your system to support the Quality Management for

warehouse processes feature for warehouse 51. (The demo data defines a quality management location that is

named QMS. That location is referenced several times in this scenario.) You will prepare the following elements,

as described in the subsections of this section:

Work class



Work class for quality-inWork class for quality-in

Work templateWork template

Location directiveLocation directive

Work template

Location directive

Item sampling

Quality association

Mobile device menu items

1. Go to Warehouse management > Setup > Work > Work classesWarehouse management > Setup > Work > Work classes .

2. Create a work class, and set the following values:

Work class ID:Work class ID: QualityIn

Descr iption:Descr iption: Quality item sampling

Work order type:Work order type: Quality item sampling

1. Go to Warehouse management > Setup > Work > Work templatesWarehouse management > Setup > Work > Work templates .

2. Set the Work order typeWork order type field to Quality item sampling.

3. Create a work template, and set the following values:

Work template:Work template: 51 Quality

Work template descr iption:Work template descr iption: 51 Quality

4. Add a line to the work template, and set the following values:

Work type:Work type: Pick

Work class ID:Work class ID: QualityIn

5. Add a second line to the work template, and set the following values:

Work type:Work type: Put

Work class ID:Work class ID: QualityIn

1. Go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives .

2. Set the Work order typeWork order type field to Quality item sampling.

3. Create a location directive, and set the following values:

Name:Name: 51 to quality

Work type:Work type: Put

Site:S ite: 5

Warehouse:Warehouse: 51

4. Add a line for the location directive, and set the following values:

From quantity:From quantity: 1

To quantity:To quantity: 1000000

5. Create a location directive action, and set the following value:

Name:Name: Quality

6. For the new location directive action, select Edit quer yEdit quer y , and specify a RangeRange record that has the

following values:

Table:Table: Locations

Field:Field: Location profile ID
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Criter ia:Cr iter ia: QMS

7. Select OKOK to save the query, and save the new location directive.

Next, you must change the sequence of the existing purchase order location directives for warehouse 51. The

demo data includes two location directives that have a Work order typeWork order type value of Purchase: one is named 51

QMS, and the other is named 51 PO Direct. To ensure that the Quality management for warehouse processes

feature is applied for warehouse 51, you must make sure that the 51 QMS location directive isn't applied.

However, instead of deleting that location directive (because you might want to use it in the future), you can just

change the sequence.

1. Go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives .

2. Set the Work order typeWork order type field to Purchase order.

3. In the sequence list, select sequence number 5, for the 51 PO Direct location directive.

4. Move the selected sequence up to sequence number 4.

5. Verify that sequence number of the 51 QMS location directive is now at least 5.

The Quality management for warehouse processes feature adds some new item sampling capabilities. The

Sampling scopeSampling scope value can now be Order, Shipment, or Load, and the Sampling quantitySampling quantity  value can now be

Full license plate.

1. Go to Inventor y management > Setup > Quality control > Item samplingInventor y management > Setup > Quality control > Item sampling.

2. Create an item sampling record, and set the following values:

Item sampling:Item sampling: 3rd LP

Descr iption:Descr iption: Every third license plate

Sampling Scope:Sampling Scope: Order

3. On the Sampling quantitySampling quantity  FastTab, set the Quantity specificationQuantity specification field to Full license plate.

4. On the ProcessProcess  FastTab, set the Per nth license platePer nth license plate field to 3.

5. In the Per storage dimensionPer storage dimension section, enable both WarehouseWarehouse and Inventor y statusInventor y status .

Create a quality association that will use the new item sampling.

1. Go to Inventor y management > Setup > Quality control > Quality associationsInventor y management > Setup > Quality control > Quality associations .

2. Create a quality association record, and set the following values:

Reference type:Reference type: Purchase

Item code:Item code: Table

Item:Item: M9201

Site:S ite: 5

3. On the ProcessProcess  FastTab, set the Event typeEvent type field to Registration.

4. On the ConditionsConditions  FastTab, set the Applicable warehouse typeApplicable warehouse type field to Quality management for

warehouse processes only.

5. On the Quality order processQuality order process  FastTab, set the Quality processing policyQuality processing policy  field to Create quality order.

6. On the SpecificationsSpecifications  FastTab, right-click in the Test GroupTest Group field, and then select View detailsView details  to open

the Test groupsTest groups  page.

7. On the Test groupsTest groups  page, on the Over viewOver view  tab of the upper grid, create a test group, and set the

following values:
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Test Group:Test Group: QMS

Descr iption:Descr iption: QMS test

Acceptable quantity:Acceptable quantity: 100

Item Sampling:Item Sampling: 3rd LP (Select)

8. On the Over viewOver view  tab of the lower grid, add a record for one test, and set the following values:

Sequence:Sequence: 1

Test:Test: Enclosure measuring

9. On the TestTest tab of the lower grid, set the following values:

Test var iables:Test var iables: Pass/Fail

Default outcome:Default outcome: Pass

10. Save the new test group, and close the Test groupsTest groups  page.

11. Back on the Quality associationsQuality associations  page, in the Test groupTest group field, select QMSQMS .

12. Save the record.

To complete the setup to move goods to the quality control location, you must make the quality item sampling

work available from a mobile device menu item.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. Select the Purchase Put-awayPurchase Put-away  mobile device menu item.

3. On the Work classesWork classes  FastTab, add the QualityIn work class ID.

You've now defined a quality association that uses the Quality management for warehouse processes feature to

trigger the creation of a quality order. You've set up the work and location data for warehouse 51 to ensure that

specific work is created when purchase registration is done for item M9201. This setup ensures that every third

license plate that is registered will be moved to a quality location (QMS), and that a quality order will be created

for the license plate quantity. Everything else will be moved to put-away instead of the quality control location.

1. Go to Procurement and sourcing > Purchase orders > All purchase ordersProcurement and sourcing > Purchase orders > All purchase orders .

2. Create a purchase order, and set the following values:

Specify Vendor account:Specify Vendor account: 104

Warehouse:Warehouse: 51

3. Add a purchase order line, and set the following values:

Item:Item: M9201

Quantity:Quantity: 20

UoM:UoM: ea

Warehouse:Warehouse: 51

4. Write down the purchase order number, so that you can use it later.

5. Go to a mobile device or emulator that is running the warehouse app, and sign in to warehouse 51 by

using 51 as the user ID and 1 as the password.

6. Go to Inbound > Purchase ReceiveInbound > Purchase Receive, and enter the following values:

PONum:PONum: The number of the purchase order that you just created

Qty:Qty: 5

Unit:Unit: ea
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7. Continue to receive against the line, 5 ea at a time, until the line is fully received. (A total of four license

plates will be created.)

8. Sign out of the warehouse app.

9. Back in the web client, go to Procurement and sourcing > Purchase orders > All purchaseProcurement and sourcing > Purchase orders > All purchase

ordersorders .

10. Find and open your purchase order.

11. In the Purchase order linesPurchase order lines  section, select the line for item number M9201, and then select PurchasePurchase

order lines > Work detailsorder lines > Work details .

12. Notice that the second and third work headers that were created are regular put-away work, whereas the

first and the fourth work headers are quality item sampling work. This result is consistent with the item

sampling setup, which is configured to sample every third license plate.

You will now move the license plates to their designated locations. The first and fourth license plates will go to

the quality control location, whereas the second and third license plates will go directly to storage.

1. Go to a mobile device or emulator that is running the warehouse app, and sign in to warehouse 51 by using

51 as the user ID and 1 as the password.

2. Go to Inbound > Purchase put awayInbound > Purchase put away , and put away each license plate from the previous procedure until

you've closed all the work.

You've now run the quality item sampling work for the first and fourth license plates by moving them to the

quality control location. You've also put away the second and third license plates. The next step is to do the

quality order testing and control.

When workers report quality order results, the system automatically generates work.

You will now continue with the required base setup of the work class, work template, and location directive to

enable quality management for warehouse processes, so that the required work can be created to move the

quality order quantity from the quality control location to a designated warehouse location.

1. Go to Warehouse management > Setup > Work > Work classesWarehouse management > Setup > Work > Work classes .

2. Create a work class, and set the following values:

Work class ID:Work class ID: QualityOut

Descr iption:Descr iption: Quality Out

Work order type:Work order type: Quality Order

1. Go to Warehouse management > Setup > Work > Work templatesWarehouse management > Setup > Work > Work templates .

2. Change the Work order typeWork order type value to Quality order.

3. Create a work template, and set the following values:

Work template:Work template: 51 quality out

Work template descr iption:Work template descr iption: 51 quality out

4. Add a line, and set the following values:

Work type:Work type: Pick
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Work class ID:Work class ID: QualityOutQualityOut

5. Add a second line, and set the following values:

Work type:Work type: Put

Work class ID:Work class ID: QualityOut

1. Go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives .

2. Change the Work order typeWork order type value to Quality order.

3. Create a location directive, and set the following values:

Name:Name: 51 Pass

Work type:Work type: Put

Site:S ite: 5

Warehouse:Warehouse: 51

4. On the Action Pane, select Edit quer yEdit quer y  to open the query editor dialog box.

5. On the RangeRange tab, set the following values:

Table:Table: Quality orders

Field:Field: Status

Criter ia:Cr iter ia: Pass

6. Select OKOK to save the query and close the dialog box.

7. On the L inesLines  FastTab, add a line, and set the following values:

From quantity:From quantity: 1

To quantity:To quantity: 1000000

8. On the Location directive actionsLocation directive actions  FastTab, add a row, and set the following value:

Name:Name: Pass

9. On the Location directive actionsLocation directive actions  FastTab, select Edit quer yEdit quer y  to open the query editor dialog box.

10. On the RangeRange tab, set the following values:

Table:Table: Locations

Field:Field: Zone ID

Criter ia:Cr iter ia: Bulk

11. Select OKOK to save the query and close the dialog box.

12. On the Action Pane, select SaveSave to save the new location directive.

13. Create a second location directive, and set the following values:

Name:Name: 51 Fail

Work type:Work type: Put

Site:S ite: 5

Warehouse:Warehouse: 51

14. On the Action Pane, select Edit quer yEdit quer y  to open the query editor dialog box.

15. On the RangeRange tab, set the following values:

Table:Table: Quality orders

Field:Field: Status

Criter ia:Cr iter ia: Fail
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16. Select OKOK to save the query and close the dialog box.

17. On the L inesLines  FastTab, add a line, and set the following values:

From quantity:From quantity: 1

To quantity:To quantity: 1000000

18. On the Location directive actionsLocation directive actions  FastTab, add a row, and set the following value:

Name:Name: Fail

19. On the Location directive actionsLocation directive actions  FastTab, select Edit quer yEdit quer y  to open the query editor dialog box.

20. On the RangeRange tab, set the following values:

Table:Table: Locations

Field:Field: Zone ID

Criter ia:Cr iter ia: Return

21. Select OKOK to save the query and close the dialog box.

22. On the Action Pane, select SaveSave to save the new location directive.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. Select the QMS put-awayQMS put-away  mobile device menu item.

3. On the Work classesWork classes  FastTab, add the QualityPut work class ID.

Warehouse workers will now be able to pick quality order work by using the QMS Put-awayQMS Put-away  menu item. Goods

that failed quality control goods can be put in a return location, and goods that passed can be put in the bulk-

001 location.

You've set up the work and location data for warehouse 51, to ensure that work is automatically created when

quality orders are completed. This setup ensures that each quality-controlled license plate is moved to either a

bulk location or a return location.

1. Go to Inventor y management > Periodic tasks > Quality management > Quality ordersInventor y management > Periodic tasks > Quality management > Quality orders .

2. Select the first quality order for the quantities that were registered.

3. Select ValidateValidate. The status of the test is updated to Fail.

4. Go to Warehouse management > All workWarehouse management > All work .

5. Open the work that you just created, and notice that the Work order typeWork order type value is Quality order. The

work includes a line where the put location is Return and the status is Fail. (If the status of the quality

order were Pass, the put location would be Bulk instead.)

6. Go back to Inventor y management > Periodic tasks > Quality management > Quality ordersInventor y management > Periodic tasks > Quality management > Quality orders .

7. Select the second quality order for the items that were registered.

8. Select ResultsResults  above the lower grid. Update the Result quantityResult quantity  value to 5, and verify that the TestTest

resultresult value is changed to a check mark.

9. Select ValidateValidate, and close the page.

10. Back on the Quality ordersQuality orders  page, select ValidateValidate, and do the validation. The status is updated to Pass.
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The validation event triggers the creation of the quality order work to move the quantity from the quality control

location to a new location.

11. Go to Warehouse management > All workWarehouse management > All work .

12. Select the work that was just created, and notice that a second quality order work header has been

created, where the put location is BULK-001.

13. Go to a mobile device or emulator that is running the warehouse app, and sign in to warehouse 51 by

using 51 as the user ID and 1 as the password.

14. Go to Quality > Put Away from QMSQuality > Put Away from QMS , and process each of the two license plates that are related to

both pieces of work, so that all work is closed.

Consider adding the quality-out entry to a mobile device menu item where the activity code is Display open work list. For

an example, see the mobile device menu item that is named Work listWork list  in the demo data. First add the Quality order work

class to a user-directed menu item, because this work class is required for work to be shown in the work list. Then add the

Quality order work class to the Work listWork list  menu item. Users who have access to the work list will then be able to pick and

process the work that is automatically generated by quality order validation.
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This article describes the basic setup that is required in order to use nonconformances. Additional setup is

required if you want to use quality orders.

To enable nonconformance management, follow these steps:

1. Define the Inventory and warehouse management parameters that are related to nonconformances:

Set the Use quality managementUse quality management option to YesYes .

In the Hourly rateHourly rate field, enter an hourly labor rate in the local currency. The hourly rate is used to

calculate costs for operations that are related to a nonconformance. The hourly rate and calculated

costs provide reference information for a nonconformance. They don't interact with other

functionality.

Use the Quality managementQuality management tab on the Repor t setupRepor t setup page to define the type of document to

print. You can print a nonconformance report, a nonconformance tag, or a correction report. You can

define more than one record to print different document types on a report, or to print internal and

external notes. You might find it helpful to use the Document typeDocument type page to define a unique document

type for nonconformances and a unique document type for corrections. For example, want to enter

notes about a nonconformance by using the unique document type for nonconformances. In this case,

identify the unique document type in the report options.

Enable number sequences for nonconformance and correction references.

2. Enable user approval of nonconformances. Use the NameName field on the UsersUsers  page to assign an employee

to each user who must approve a nonconformance. The system uses the employees who change the

status of a noncomformance to track the nonconformance history. Users can't approve a

nonconformance unless they have been assigned an employee identifier.

3. Define the problem types that will be assigned to nonconformances. Use the Problem typesProblem types  page to

define a classification of quality problems that are encountered for the various nonconformance types.

You can set up the following nonconformance types: InternalInternal , CustomerCustomer , VendorVendor , Ser vice requestSer vice request,

ProductionProduction, and Co-product productionCo-product production. Use the Non conformance typesNon conformance types  page to authorize a

problem type to be used in one or more nonconformance types. For example, a problem type that is

related to a defect code might apply to all nonconformance types, whereas a problem type that is related

to customer complaints might apply only to the CustomerCustomer  and Ser vice requestSer vice request nonconformance

types.

4. Define quarantine zones to provide guidance about defective material should be handled. Use the

Quarantine zonesQuarantine zones  page to define zones that can be assigned to a nonconformance. The printed

nonconformance tag will show the assigned quarantine zone and information about usage, to provide

guidance about how to handle defective material. The zones might correspond to inventory locations or

operations resources.

5. Define the diagnostic types that will be assigned to corrections. Use the Diagnostic typesDiagnostic types  page to define

a classification of diagnostic actions. A correction specifies what type of diagnostic action should be taken

for an approved nonconformance, and who should take that action. It also specifies the requested

completion date and the planned completion date.

6. Define the related operations that will be assigned to nonconformances. Use the OperationsOperations  page to

define a classification of the work that can be performed for an approved nonconformance. When you

assign a related operation to a nonconformance, you can provide detailed information, such as

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/enable-nonconformance-management.md
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information about the associated material, labor hours, and miscellaneous charges that are required in

order to perform the operation. This information is used to calculate an estimated cost for the operation.

The detailed information and estimated costs are for reference. The related operations for quality differ

from the operations that can be defined for a production route.

Create and process a conformance

Quality management processes

Set up prerequisites for nonconformance management

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Enable quality management processes within the company

Enable user for nonconformance processing

Define diagnostic types for nonconformance processing

Define quality charges for nonconformance processing

Use this topic to enable nonconformance management processes. A nonconformance describes a procedure or

item that has a quality problem, where the descriptive information includes the source and type of problem. This

procedure uses the USMF demo data company. This procedure is typically performed by a quality manager.

1. In the navigation pane, go to Modules > Inventor y management > Setup > Inventor y andModules > Inventor y management > Setup > Inventor y and

warehouse management parameterswarehouse management parameters .

2. Select the Quality managementQuality management tab.

3. Select YesYes  in the Use quality managementUse quality management field to enable quality management processes for the company.

4. In the Hourly rateHourly rate field, enter a number in the local currency. The hourly rate is used for calculating costs for

operations that are related to a nonconformance. The hourly rate and calculated costs provide reference

information for a nonconformance, and they do not interact with other functionality.

5. Select Repor t setupRepor t setup to define the quality report note types that will be used on different kinds of quality

management reports.

1. In the navigation pane, go to Modules > System administration > Users > UsersModules > System administration > Users > Users .

2. Use the Quick Filter to find the user who will be approving or rejecting the nonconformance records. For

example, filter on the NameName field with a value of Ricardo . To process the approval of a nonconformance, the

user who approves or rejects nonconformances must have a "Name" value assigned on the UsersUsers  page. To

use the document notes, the user must also have Document handling activated in the user options.

3. Mark the row of the desired record.

4. Select User optionsUser options .

5. Select the PreferencesPreferences  tab.

6. Select YesYes  in the Enable document handlingEnable document handling field.

1. In the navigation pane, go to Modules > Inventor y management > Setup > Quality management >Modules > Inventor y management > Setup > Quality management >

Diagnostic typesDiagnostic types . Use the Diagnostic typesDiagnostic types  page to define a classification of diagnostic actions. A

correction identifies what type of diagnostic action should be taken on an approved nonconformance, who

should perform it, and the requested and planned completion date.

2. Select NewNew .

3. In the DiagnosticDiagnostic field, type a value.

4. In the Descr iptionDescr iption field, type a value.

1. In the navigation pane, go to Modules > Inventor y management > Setup > Quality management >Modules > Inventor y management > Setup > Quality management >

Quality chargesQuality charges . Use the Quality chargesQuality charges  page to define a classification of charges that will used in

operations related to nonconformances.
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2. Select NewNew .

3. In the Charges codeCharges code field, type a value.

4. In the Descr iptionDescr iption field, type a value.

1. In the navigation pane, go to Modules > Inventor y management > Setup > Quality management >Modules > Inventor y management > Setup > Quality management >

OperationsOperations . Use the OperationsOperations  page to define a classification of the work that may be performed for an

approved nonconformance. When you relate an operation to a nonconformance, you can define information

about the associated material, labor hours, and miscellaneous charges that are required to perform the

operation. This information provides the basis for calculating an estimated cost for performing the operation.

2. Select NewNew .

3. In the OperationOperation field, type a value.

4. In the Descr iptionDescr iption field, type a value.

1. In the navigation pane, go to Modules > Inventor y management > Setup > Quality management >Modules > Inventor y management > Setup > Quality management >

Problem typesProblem types . Use the Problem typesProblem types  page to define a classification of quality problems that are

encountered in the various nonconformance types. The nonconformance types include InternalInternal , CustomerCustomer ,

VendorVendor , Ser vice requestSer vice request, ProductionProduction, and Co-product productionCo-product production. A single problem type can be

associated with multiple nonconformance types.

2. Select NewNew .

3. In the Problem typeProblem type field, type a value.

4. In the Descr iptionDescr iption field, type a value.

5. Select Non conformance typesNon conformance types . Use the Non conformance typesNon conformance types  page to authorize the use of a

problem type for one or more of the nonconformance types. For example, a problem type regarding a defect

code could apply to all nonconformance types, whereas a problem type about customer complaints may only

apply to the customer and service request nonconformance types.

6. Select NewNew .

7. In the Non conformance typeNon conformance type field of the new row, select an option.

1. In the navigation pane, go to Modules > Inventor y management > Setup > Quality management >Modules > Inventor y management > Setup > Quality management >

Quarantine zonesQuarantine zones .

2. Select NewNew .

3. In the Quarantine zoneQuarantine zone field, type a value.

4. In the Descr iptionDescr iption field, type a value.

5. Close the page.
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Select a quality order

Create a nonconformance

Approve/reject a nonconformance

Create a correction action

This topic explains how to perform nonconformance management, based on an existing quality order. You can

run this recording in the USMF demo company and can use the suggested values. Typically, this procedure is

performed by a quality clerk. As a prerequisite, complete the instructions in Inspect the quality of goods. To

process the approval of a nonconformance, the user who runs the task recording must have a "Name" value

assigned on the Users page. To use the document notes, the user must also have Document handling activated

in the user options.

1. In the navigation pane, go to Modules > Inventor y management > Periodic tasks > QualityModules > Inventor y management > Periodic tasks > Quality

management > Quality ordersmanagement > Quality orders .

2. In the list, select the quality order that was created in Inspect the quality of goods.

1. On the Action Pane, select Inquir iesInquir ies .

2. Select Non conformancesNon conformances .

3. Select NewNew .

4. In the drop-down menu of the Problem typeProblem type field, select the problem that was found during the inspection

process.

5. Select OKOK.

1. Select FunctionsFunctions .

2. Select Approve non conformanceApprove non conformance. For this example, approve the nonconformance. Approved

nonconformances can be associated with related operations to record work that is done as part of the

nonconformance handling and, as in this topic, the processing of correction handling.

3. Select YesYes .

1. Select CorrectionsCorrections .

2. Select NewNew .

3. In the Personnel numberPersonnel number  field of the new row, select the desired record from the drop down menu.

4. Click SelectSelect.

5. Select AttachAttach. Create a note about the correction. For this example, the action is to contact the vendor to

discuss the nonconformance case.

6. Select NewNew .

7. Select NoteNote. Depending on the report setup, different document types can be printed on the reports that are

related to nonconformance management.

8. In the Descr iptionDescr iption field, type a value.

9. Close the page.
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1. Select Mark completeMark complete.

2. Select OKOK.

3. Close the page.

1. Select FunctionsFunctions .

2. Select Close non conformanceClose non conformance.

3. Select YesYes .

4. Close the pages.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Quarantine on-hand inventory items

Quarantine order statuses

CreatedCreated

StartedStarted

Reported as finishedReported as finished

This topic describes how quarantine orders are used to block inventory.

Quarantine orders can be used to block inventory. For example, you might want to quarantine items for quality

control reasons. Inventory that has been quarantined is transferred to a quarantine warehouse. Note:Note: If you're

using advanced warehouse management processes (in Warehouse management), quarantine order processing

is used only for return sales orders.

When you quarantine items, you can either create the quarantine orders manually or set up the system to create

the quarantine orders automatically during inbound processing. To create quarantine orders automatically,

select the Quarantine managementQuarantine management option on the Inventor y policiesInventor y policies  tab on the Item model groupsItem model groups  page.

You must also specify a default quarantine warehouse in the Quarantine warehouseQuarantine warehouse field for the receiving

warehouses. When the physically on-hand inventory is recorded in a purchase order or production order,

quarantined items are automatically moved to a quarantine warehouse in Supply Chain Management. This

movement occurs because the status of the quarantine order is changed to Star tedStar ted. When you create

quarantine orders manually, the item doesn't have to be set up for quarantine management in the associated

item model group. For this process, you must specify the on-hand inventory that should be quarantined and the

quarantine warehouse that should be used. You can use the quarantine order statuses to help plan the process.

Quarantine orders can have the following statuses:

Created

Started

Reported as finished

Ended

When a quarantine order has been created manually, but the item isn't yet in the quarantine warehouse, the

quarantine order has a status of CreatedCreated. Two inventory transactions are generated. One transaction is an issue

transaction that can have a status of On orderOn order , Reser ved physicalReser ved physical , or PickedPicked. The other transaction is a

receipt transaction that can have a status of OrderedOrdered or RegisteredRegistered at the quarantine warehouse. You can

reserve, pick, and register updates to the inventory by using the usual processes.

When a quarantine order has a status of Star tedStar ted, the inventory is transferred from the regular warehouse to

the quarantine warehouse, and two inventory transactions are generated. One transaction has a status of

DeductedDeducted, and the other transaction has a status of ReceivedReceived. At the same time, two inventory transactions are

created to handle the return transfer. These transactions aren't dated. One transaction has a status of Reser vedReser ved

physicalphysical , and the other transaction has a status of OrderedOrdered.

By clicking Repor t as finishedRepor t as finished, you can report a started quarantine order as finished. The item is released from

quarantine but isn't yet moved back to the regular warehouse. The movement back to the regular warehouse

can be processed via an Item arrival journal that can be initialized during the Report as finished process.
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When a quarantine order is ended, the item is moved from the quarantine warehouse back to the regular

warehouse. The status of the item transaction is set to SoldSold at the quarantine warehouse and PurchasedPurchased at the

regular warehouse.

As part of the quarantine order process, you can scrap inventory. When you process scrap, the status of the

inventory will be set to SoldSold by an issue transaction from the quarantine warehouse.

Inventory blocking
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Enable quality management

Create a test

Create Test variables to define the way test results are recorded

This procedure shows you how to enable a quality management process where incoming inventory must be

inspected immediately after arrival registration. The procedure will typically be carried out by a quality manager.

The process includes the creation of a quality group, to define the items that are going to be sampled, and a test

group to group the tests that are to be performed on items in the quality group. You can run this guide in the

USMF demo data company.

1. Go to Navigation pane > Modules > Inventor y management > Setup > Inventor y andNavigation pane > Modules > Inventor y management > Setup > Inventor y and

warehouse management parameterswarehouse management parameters .

2. Click the Quality managementQuality management tab.

3. Set the Use quality management optionUse quality management option to 'Yes'.

4. Click Repor t setupRepor t setup. In USMF, the report setup for quality management is already defined. If this wasn't done,

you'd add new lines here for the different report types, and select the type of document to be used for each

report.

5. Close the page.

6. Close the page.

1. Go to Inventor y management > Setup > Quality control > TestsInventor y management > Setup > Quality control > Tests .

2. Click NewNew .

3. In the TestTest field, type a value.

4. In the Descr iptionDescr iption field, type a value.

5. In the TypeType field, select 'Option'. In this example, we'll select "Option" which will make it possible to assign

the test results based on pre-defined values.

6. Click SaveSave.

7. Close the page.

1. Go to Inventor y management > Setup > Quality control > Test var iablesInventor y management > Setup > Quality control > Test var iables .

2. Click NewNew .

3. In the VariableVariable field, type a value.

4. In the Descr iptionDescr iption field, type a value.

5. Click SaveSave.

6. Click OutcomesOutcomes .

7. Click NewNew .

8. In the OutcomeOutcome field, type a value.

9. In the Descr iptionDescr iption field, type a value.

10. In the Outcome statusOutcome status  field, select 'Pass'.

11. Click SaveSave.

12. Click NewNew .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/tasks/set-up-quality-orders.md
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Create a quality group

Create a test group

13. In the OutcomeOutcome field, type a value.

14. In the Descr iptionDescr iption field, type a value.

15. Click SaveSave.

16. Close the page.

17. Close the page.

1. Go to Inventor y management > Setup > Quality control > Item samplingInventor y management > Setup > Quality control > Item sampling.

2. Click NewNew .

3. In the Item samplingItem sampling field, type a value.

4. In the Descr iptionDescr iption field, type a value.

5. In the ValueValue field, enter a number. This value relates to the Quantity specification that's selected in the

adjacent field.

6. Expand or collapse the ProcessProcess  section.

7. Select or clear the Full blockingFull blocking check box. If you select this option, the whole lot or order line quantity is

blocked if a test is failed. If you don't select it, only the items in the quality order are blocked.

8. Click SaveSave.

9. Close the page.

The Quality management for warehouse processes feature provides additional item sampling capabilities. It adds a

concept of item sampling scope and the ability to define a full license plate as the quantity specification. If you have

enabled this feature, then see Quality management for warehouse processes for details.

1. Go to Inventor y management > Setup > Quality control > Quality groupsInventor y management > Setup > Quality control > Quality groups .

2. Click NewNew .

3. In the Quality groupQuality group field, type a value. Use a descriptive name to help you identify which kind of items the

group will contain (your sampling criteria).

4. In the Descr iptionDescr iption field, type a value.

5. Click SaveSave.

6. Click Add itemsAdd items .

7. Select the Item numberItem number  row. In this example the filtering will be run based on the item number.

8. In the Criter iaCriter ia field, type a value. For example, type T* to filter on the item numbers that start with T.

9. Click OKOK.

10. Click OKOK.

11. Click Item quality groupsItem quality groups .

12. Close the page.

13. Close the page.

1. Go to Inventor y management > Setup > Quality control > Test groupsInventor y management > Setup > Quality control > Test groups .

2. Click NewNew .

3. In the Test groupTest group field, type a value. Give the Test groupTest group a name that will help you remember what kind of

tests are being run, and which quality group it should be associated with. For example, it it's to be used with a
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quality group that selects items starting with "T", you could call it "T-item tests".

4. In the Descr iptionDescr iption field, type a value.

5. In the Item samplingItem sampling field, select the item sampling line that you created before.

6. In the list, find and select the desired record.

7. Click AddAdd.

8. In the Sequence numberSequence number  field, enter a number.

9. In the TestTest field, select the test that you created earlier.

10. In the list, find and select the desired record.

11. Click the TestTest tab.

12. In the VariableVariable field, select the test variable that you created before

13. In the list, find and select the desired record.

14. In the Default outcomeDefault outcome field, click the drop-down button to open the lookup.

15. In the list, click the link in the selected row.

16. Click SaveSave.

17. Close the page.

1. Go to Inventor y management > Setup > Quality control > Quality associationsInventor y management > Setup > Quality control > Quality associations .

2. Click NewNew .

3. In the Reference typeReference type field, select an option.

4. In the Item codeItem code field, select 'Group'. In this example, we'll select "Group" and use the quality group we

created before. You could also set this to "Table" to specify the items manually, or select "All" to add all items

to the quality order.

5. In the ItemItem field, select the quality group that you created before. The options available in the Item field

depend on what you set in the Item code field.

6. In the list, find and select the desired record.

7. Expand or collapse the Process section.

8. In the Event typeEvent type field, select an option. This is the event that triggers the test. The options available here

depend on which process you selected in the Reference type field.

9. In the ExecutionExecution field, select an option.

10. Expand or collapse the Quality order processQuality order process  section.

11. In the Event blockingEvent blocking field, click the drop-down button to open the lookup. This field shows the list of

processes that it's possible to block if the quality order is still open. The options depend on what you selected

in the Event type field.

12. In the list, click the link in the selected row. This will be depending on the previous selected values. Select if

the following processes must be blocked while having open quality orders linked to a source document line.

13. Expand or collapse the SpecificationsSpecifications  section.

14. In the Test groupTest group field, select the test group that you created before.

15. In the list, find and select the desired record.

16. Click SaveSave.

17. Close the page.

The Quality management for warehouse processes feature provides additional options for setting up quality associations.

It adds a new condition (Applicable warehouse typeApplicable warehouse type) and a new setting (Quality processing policyQuality processing policy ). If you have

enabled this feature, then see Quality management for warehouse processes for details.
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Select a quality order

Record test results

Validate the quality order

NOTENOTE

This topic explains how to process a quality order. You can run this guide in demo data company USMF. Before

you start this example procedure, you need to confirm purchase order "000016" and post a product receipt. This

will automatically create a quality order. Quality inspections are typically carried out by a quality clerk.

1. In the navigation pane, go to Modules > Inventor y management > Periodic tasks > QualityModules > Inventor y management > Periodic tasks > Quality

management > Quality ordersmanagement > Quality orders .

2. Select the quality order that was created before you started this procedure.

1. Select ResultsResults .

2. Select EditEdit.

3. In the Result quantityResult quantity  field, enter a number.

4. In the OutcomeOutcome field, select the desired record in the drop-down menu.

In this example the result is based on a pre-defined outcome. Normally you would record a more specific test

result, for example a size or other dimension.

5. Select SaveSave.

6. Close the page.

1. Select ValidateValidate.

2. In the Validated byValidated by  field, select the user performing the inspection from the drop-down menu.

3. Click SelectSelect.

4. Select OKOK.

5. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.
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Blocking items manually

Blocking items by creating a quality order
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Blocking items by using a process that generates a quality order

ExampleExample

This topic provides an overview of inventory blocking, which is part of the quality inspection process in Supply

Chain Management. You can use inventory blocking to prevent items from being processed or consumed.

You can block inventory items in the following ways:

Manually

By creating a quality order

By using a process that generates a quality order

By using inventory status blocking

You can block a quantity of an item by creating a transaction on the Inventor y blockingInventor y blocking page. Only items that

are available as on-hand inventory can be blocked manually. For manually blocked quantities, you must decide

whether planning activities include expected receipts as an expected on-hand quantity. Expected receipts are

blocked items that you expect to be available as on-hand inventory after inspection is completed. You can

maintain the expected date. By default, the Expected receiptsExpected receipts  option is selected for items that are blocked

through a quality order. You can cancel a manual block on a quantity by deleting the transaction on the

Inventor y blockingInventor y blocking page.

You can specify items that must be inspected by creating a quality order on the Quality ordersQuality orders  page. When you

create a quality order, the quantity that you specify for an item is blocked. The sampling plan that is associated

with a quality order controls only the quantity of items that must be inspected, not the quantity that is blocked.

The quantity that is entered on the quality order is the quantity that is blocked, regardless of the quantity that

the sampling plan specifies should be sent for inspection.

Using both the batch expiry date and blocking inventory status features is not supported by master planning. This could

result in double exclusion of on-hand inventory, which can occur during master planning. We recommend that you rely

on batch disposition codes, instead of inventory status, for blocking expired batches.

If a quality process specifies that an item must be inspected, a quantity of the item is blocked automatically.

Therefore, when a quality order is generated automatically, the item sampling plan that is associated with the

quality order controls the both quantity of items that is blocked and the quantity that must be inspected. If the

Full blockingFull blocking option on the Item samplingItem sampling page is selected, the full quantity of, for example, a purchase order

line is blocked during inspection, regardless of the item sampling quantity.

In the following example, a quality order is generated when a purchase order packing slip is posted. On the

Quality associationsQuality associations  page, you specified that posting of a purchase order packing slip is the process that

activates a quality order.
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A quality association specifies that a
quality order must be generated when
a purchase order packing slip is
posted. The item sampling setup of
the quality order specifies that 10
percent of the quantity on the
purchase order line must be inspected.
Furthermore, because the FullFull
blockingblocking option selected in the item
sampling setup, the full quantity of the
purchase order line must be blocked
during inspection, regardless of the
quantity that is sent for inspection.

The packing slip is posted. A quality order is generated. Ten
percent of the purchase order quantity
for the item is sent to inspection. The
full quantity of the purchase order line
is blocked.

Blocking items by using inventory status blocking
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You can specify which inventory statuses are blocking statuses by using the Inventor y blockingInventor y blocking parameter on

the Inventor y statusesInventor y statuses  page. You can't use inventory statuses as blocking statuses for production orders, sales

orders, transfer orders, outbound transactions, or project integrations. For outbound work, use items that have

an available inventory status. If items have a status of BrokenBroken, and master planning is run on those items, the

items are considered missing, and inventory is automatically replenished.

Create and maintain an inventory blocking

Quality management processes

Inspect the quality of goods
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Create an inventory blocking

Update the conditions of the inventory blocking

Remove the inventory blocking
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This procedure shows how to prevent physical on-hand inventory from being reserved by other outbound

source documents by using the inventory blocking. You can run the procedure in demo data company USMF

using the example values that are shown. You need to have an item with physical on-hand inventory available

before you start this procedure.

1. In the Navigation paneNavigation pane, go to Modules > Inventor y management > Periodic tasks > Inventor yModules > Inventor y management > Periodic tasks > Inventor y

blockingblocking.

2. Click NewNew .

3. In the Item numberItem number  field, click the drop-down button to open the lookup.

4. In the list, select the item you want to choose. Select an item number with physical on-hand inventory that

you want to block. If you're using USMF you can select item M9201.

5. In the QuantityQuantity  field, enter a number. If you're using item M9201, you need to select less than 200.

6. Expand the Inventor y dimensionsInventor y dimensions  fastTab.

7. In the WarehouseWarehouse field, click the drop-down button to open the lookup.

8. In the list, find and select the desired record. If you're using item M9201, you can select warehouse 51.

9. Click SaveSave.

1. In the GeneralGeneral  fastTab, in the QuantityQuantity  field, enter a number. Update the inventory quantity field to reflect

the quantity to block.

2. In the Expected dateExpected date field, enter a date. You might want to indicate when the blocked inventory is expected

to become available for reservation by assigning an expected date. If the Expected receipts option is selected

for the inventory blocking, as it is by default when you manually create a blocking, this date will appear on

the expected transaction.

3. Click SaveSave.

1. On the Action PaneAction Pane, click DeleteDelete.

2. Click YesYes .

3. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.
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Types of inventory journals

MovementMovement

Inventory adjustmentInventory adjustment

TransferTransfer

BOMBOM

This topic describes how you can use inventory journals to post various types of physical inventory transactions.

The inventory journals in Supply Chain Management are used to post physical inventory transactions of various

types, such as the posting of issues and receipts, inventory movements, the creation of bills of materials (BOMs),

and the reconciliation of physical inventory. All these inventory journals are used in a similar way, but they are

divided into different types.

The following types of inventory journals are available:

Movement

Inventory adjustment

Transfer

BOM

Item arrival

Production input

Counting

Tag counting

When you use an inventory movement journal, you can add cost to an item when you add inventory, but you

must manually allocate the additional cost to a particular general ledger account by specifying a general ledger

offset account when you create the journal. This inventory journal type is useful if you want to overwrite the

default posting accounts.

When you use an inventory adjustment journal, you can add cost to an item when you add inventory. The

additional cost is automatically posted to a specific general ledger account, based on the setup of the item group

posting profile. Use this inventory journal type to update gains and losses to inventory quantities when the item

should keep its default general ledger offset account. When you post an inventory adjustment journal, an

inventory receipt or issue is posted, the inventory values are changed, and ledger transactions are created.

You can use transfer journals to transfer items between stocking locations, batches, or product variants without

associating any cost implications. For example, you can transfer items from one warehouse to another

warehouse within the same company. When you use a transfer journal, you must specify both the "from" and

"to" inventory dimensions (for example, for Site and Warehouse). The on-hand inventory for the defined

inventory dimensions is changed accordingly. Inventory transfers reflect the immediate movement of material.

In-transit inventory isn't tracked. If in-transit inventory must be tracked, you should use a transfer order instead.

When you post a transfer journal, two inventory transactions are created for each journal line:

An inventory issue at the "from" location.

An inventory receipt at the "to" location.

When you report a BOM as finished, you can create a BOM journal. By using a BOM journal, you can post the

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/inventory-journals.md
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Production inputProduction input

CountingCounting

Tag countingTag counting

Working with journals

Posting journal lines

Data entity support for inventory journals

BOM directly. This posting generates an inventory receipt of the product, together with an associated BOM and

an inventory issue of the products that are included in the BOM. This inventory journal type is useful in simple

or high-volume production scenarios where routes aren't required.

You can use the item arrival journal to register the receipt of items (for example, from purchase orders). An item

arrival journal can be created as part of arrival management from the Arr ival over viewArr ival over view  page, or you can

manually create a journal entry from the Item arr ivalItem arr ival  page. If you enable the item arrival journal name to check

for picking locations, Supply Chain Management looks for a location for received items and, if there is room,

generates location destinations for the incoming items.

Production input journals work like the item arrival journals but are used for production orders.

Counting journals let you correct the current on-hand inventory that is registered for items or groups of items,

and then post the actual physical count, so that you can make the adjustments that are required to reconcile the

differences. You can associate counting policies with counting groups to help group items that have various

characteristics, so that those items can be included in a counting journal. For example, you can set up counting

groups to count items that have a specific frequency, or to count items when stock falls to a particular level. For

information about how to define counting groups, see Define inventory counting processes.

Tag counting journals are used to assign a numbered tag to a count lot. The tag should contain a tag number,

item number, and item quantity. To ensure that a tag is used only one time, and that all tags are used, every item

number should have a unique set of tags that has its own number sequence. Three status values can be set for

each tag:

UsedUsed – The item number is counted for this tag.

VoidedVoided – The item number is voided for this tag.

MissingMissing – The item number is missing for this tag.

When you post a tag counting journal, a new counting journal is created, based on the tag counting journal

lines. For more information about tag counting, see Inventory tag counting.

A journal can be accessed by only one user at a time. If several users must access journals at the same time to

create journal lines, those users must select journals that aren't currently being used, to prevent information

from being overwritten. In situations where multiple departments use the same journal type, it's helpful to

create multiple journal names (for example, one per department). It can also be helpful to divide journals so that

each posting routine is entered in its own unique inventory journal. For posting routines that are associated with

inventory transactions, create one journal for periodic inventory adjustments and another for inventory

counting.

You can post the journal lines that you create at any time until you've locked an item from additional

transactions. The data that you enter in a journal remains in that journal, even if you close the journal without

posting the lines.

Data entities support the following types of integration scenarios:
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Synchronous service (OData)

Asynchronous integration

For more information, see Data entities.

Not all inventory journals are OData-enabled, therefore you cannot use the Excel data connector to get data published,

updated, and imported back to Supply Chain Management.

Another difference between the journal data entities is the ability to use composite entities that include both the

header and line data. Currently, you can use the composite entities for :

Inventory adjustment journal

Inventory movement journal

These two inventory journals only support the Initialize stock scenario as part of a data management import

project:

When a journal header number is not specified, but a number sequence is specified for the journal type, the

import job will automatically create journal headers per 1000 lines. For example, importing 2020 lines will

result in the following three journal headers:

It is assumed that unique line information exists per inventory dimension, which can be a product, storage,

and tracking dimension. Therefore, it’s not possible to import journal lines where only the date field differs

on the lines within the same import project.

Header 1: will contain 1000 lines

Header 2: will contain 1000 lines

Header 3: will contain 20 lines

Data entities

Can you tell us about your documentation language preferences? Take a short survey.
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Turn on the inventory journal approval workflows feature

Create your inventory journal approval workflows

This topic describes how to set up and use inventory journal approval workflows for various types of physical

inventory transactions, such as issues and receipts, inventory movements, bills of materials (BOMs), and the

reconciliation of physical inventory. Inventory journal workflows help ensure that only approved inventory

journals can be posted to transactions.

Inventory journal approval workflows apply only to transactions recorded using the Inventory Management module. They

don't work with inventory journals triggered from the Warehouse Management module.

Before you can use this feature, it must be turned on in your system. Admins can use the feature management

settings to check the status of the feature and turn it on. In the Feature managementFeature management workspace, the feature is

listed in the following way:

Module:Module: Inventory and warehouse management

Feature name:Feature name: Inventory journal approve workflow

To set up this feature, you must create a workflow for each of the inventory journal types you want to control.

Because different inventory journal types can have different approval hierarchies and workflow steps, you can

configure individual workflows for each inventory journal type.

Workflows support version control, and each has a workflow ID and an active version. You can choose to

activate each new workflow version immediately upon creation or keep it inactive. If you need different

workflows for the same journal type, then create multiple workflows for that journal type, and then assign each

of these to a different journal name that uses that type.

To create your inventory journal approval workflows:

1. Go to Inventor y Management > Setup> Inventor y management workflowsInventor y Management > Setup> Inventor y management workflows .

2. Select NewNew  on the Action Pane.

3. Choose the inventory journal type for which you want to set up a workflow:

Inventor y tag counting journalInventor y tag counting journal

Inventor y ownership change journalInventor y ownership change journal

Inventor y movement journalInventor y movement journal

Inventor y transfer journalInventor y transfer journal

Inventor y counting journalInventor y counting journal

Inventor y BOM journalInventor y BOM journal

Inventor y adjustment journalInventor y adjustment journal

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/inventory-journal-workflow.md
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Assign approval workflows to inventory journal names

Create an inventory journal and send it for approval

4. The workflow editor app launches on your machine. (You may be asked to approve this action.) Use it to

design your workflow as needed. For details about how to use the workflow editor, see Workflow system

overview.

5. After saving and closing the workflow editor app, you must choose whether to activate this workflow

version or keep it as inactivate.

Workflows provide version control, which means that you can view a list of versions you have created and choose which

one is active. To view the list of available versions and choose which to activate, select a workflow listed on the Inventor yInventor y

management workflowsmanagement workflows page. On the Action Pane, open the WorkflowWorkflow tab, and select VersionsVersions . Only one version

can be active at a time for each workflow ID.

The next step is to assign a inventory journal workflow to each inventory journal name. For each inventory

journal type, you can set up multiple inventory journal names.

To associate an inventory journal workflow with an inventory journal name:

1. Go to Inventor y management > Setup > Journal names > Inventor yInventor y management > Setup > Journal names > Inventor y .

2. Select a journal name from the list column to open its settings page.

3. On the GeneralGeneral  FastTab, set Approval workflowApproval workflow  to YesYes . If you are prompted to approve the action,

select YesYes .

4. Open the WorkflowWorkflow  drop-down list and select the appropriate workflow. The list shows each active

workflow that you have created using the workflow editor app.



Respond to an inventory journal approval request

After you associate an inventory journal name with its matching inventory journal approval workflow, you'll be

able to create new inventory journals that use that name and then send these journals for approval using that

workflow. You won't be able post the inventory journal until it has been approved by the approvers configured

in the workflow.

1. On the navigation pane, expand Inventor y management > Journal entr ies > ItemsInventor y management > Journal entr ies > Items and then select

an inventory journal type.

2. Select NewNew  to create a new journal of your selected type.

3. The Create inventor y journalCreate inventor y journal  dialog box opens. Fill out the form as needed and then select OKOK to save

the journal.

4. Complete the journal as required.

5. When you create or open an inventory journal with an approval workflow associated with it, the

WorkflowWorkflow  button will be active in the Action Pane. When you are ready to submit the journal for

approval, select the WorkflowWorkflow  button to open a drop-down dialog box and then select SubmitSubmit. The

approval request will then route to the relevant approver, who will be alerted using the notification

method configured for the workflow.

To recall an approval request, open the relevant journal, select the WorkflowWorkflow  button and then select RecallRecall . This

will reset the workflow.

When your journal has been approved, you'll be able to post it. To post the journal, select PostPost from the Action

Pane. If the PostPost button isn't active the journal hasn't been approved yet.

If you are an approver, you should receive a message each time your approval is needed (as configured in the

relevant workflow). Then you can approve or reject a journal approval request by doing the following:

1. On the navigation pane, expand Inventor y management > Journal entr ies > ItemsInventor y management > Journal entr ies > Items and then select an

inventory journal type.

2. Open the relevant journal and review it.

3. Select the WorkflowWorkflow  button on the Action Pane to open a drop-down dialog box. Select one of the following:

ApproveApprove - To approve the request.

RejectReject - To reject the reject the request.

More > Request changeMore > Request change - To send a message to the requester asking them to change something

specific and then resubmit.

More > DelegateMore > Delegate - To delegate the approval to another user.

More > RecallMore > Recall  - To recall the approval request (resets the workflow).

More > Workflow histor yMore > Workflow histor y  - To view the history of this approval workflow so far.



Review the approval history

NOTENOTE

As with other types of workflows, you can use the Workflow histor yWorkflow histor y  page to view the approval workflow

history for any journal.

To review the workflow history for a journal:

1. On the navigation pane, expand Inventor y management > Journal entr ies > ItemsInventor y management > Journal entr ies > Items and then select an

inventory journal type.

2. Open the relevant journal.

3. Select the WorkflowWorkflow  button on the Action Pane to open a drop-down dialog box. Select Workflow histor yWorkflow histor y .

For more information, see View workflow history.
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Sort codes

Blocked locations

Tree structure

Maintain inventory locations via the warehouse form

Additional resources

Inventory locations are used with basic warehousing (WMS I) to determine where items are stored and where

items are picked from in a WMS I warehouse.

This topic applies to features in the Inventory management module. It does not apply to features in the

Warehouse management module.

The term location refers to the place that items are stored and drawn from.

For each location, the place where the item is inserted can also be specified. By default, they are the same. Items

are usually inserted and drawn from the same side of a location, but not always. For example, items that are

stored in live storage racks are inserted from one aisle and drawn from another. The main input is given by a

location name, which is usually determined by its coordinates: warehouse, aisle, rack, shelf, and bin. This name

or ID can be entered manually or generated from the location coordinates—for example, 01-02-03-4 for aisle 1,

rack 2, shelf 3, bin 4 in the Inventory locations page. Location properties

A location has the following characteristics:

Size (height, width, depth, and thereby volume)

Warehouse, aisle, rack, shelf, and bin position

Location type (bulk location, picking location, inbound dock, outbound dock, production input location,

inspection location, or kanban supermarket)

Check text can be used in online systems to verify that the operator has selected the correct location for a

specific item. This check text can be created manually or by default.

Use sort codes to optimize the handling of picking lines, which describe the information that is required for

picking items from inventory, including the picking order. Sort codes can be specified by the aisle and other

coordinates, or assigned manually for the location.

Occasionally, you might want to indicate that a location is blocked for a period of time, for example, to allow for

repairs. At other times, you may want to indicate blocking of only the input or only output.

In the Inventory locations page, you can view the warehouse layout in a tree structure based on the coordinates

of inventory locations, in a defined display format.

It is possible to copy locations from one warehouse to another and to create locations via a wizard. Before you

run the wizard you should make sure that you have defined the default location names on the Warehouse page.

Create a new warehouse layout
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Set up and use inventory statuses

NOTENOTE

This article describes how you can use inventory statuses to categorize and keep track of inventory.

You can use inventory statuses to categorize inventory. You can then initiate appropriate actions, such as

replenishment or put-away work.

Here are some examples of ways that you can use inventory statuses:

Create inventory statuses for on-hand inventory, inbound transactions, and outbound transactions.

Specify a default inventory status for warehouse transactions.

Change an inventory status for items before arrival, during arrival, or when the items are put away during

inventory movement.

Use an inventory status to price items that are returned and to plan item coverage during master planning.

An inventory status is one of the dimensions in the storage dimension group. Inventory statuses can be

categorized as available or unavailable, and you can use the Inventor y blockingInventor y blocking parameter to block items that

have an unavailable inventory status. Items that have a blocked status are considered physical inventory, and

they can't be used on a production order, sales order, transfer order, or outbound transaction.

You can use warehouse items that have either available or unavailable inventory statuses for inbound work. For

example, you create an available status that is named Ready, an unavailable status that is named Damaged, and

a blocked status that is named Blocked. When you create a purchase order for received or returned items, if any

items are damaged or broken, you can change the inventory status of those items to Damaged on the purchase

order line. After these items are received, the status is automatically set to Blocked. If you scan the damaged

items by using a mobile device, Supply Chain Management can use location directives and work templates to

show information about an appropriate location or range of locations where you can put away those items. For

returned items, an issue type of Reservation is created on the Inventor y transactionsInventor y transactions  page.

You can't change the status of inventory at locations where open work exists. For example, if you did a purchase receive

for an item, but didn't do the putaway step, then open work would exist for the receiving location and you would get an

error if you tried to change the status of inventory at that location. Completing or cancelling the related work would allow

you to change the status.

For outbound work, use items that have an available inventory status. If you have items that have a status of

Broken, and master planning is run on these items, the items are considered missing, and inventory is

automatically replenished.

After you set up inventory statuses, you can set the default inventory status for a site, item, and warehouse. You

can also set a default status for sales, transfer, and purchase orders. The default status for sales orders and

outbound transfer order can't have the Inventor y blockingInventor y blocking option set to Yes. The inventory status that is

inherited from the default settings on a site, warehouse, item, purchase order, transfer order or sales order can

be changed by using the mobile device, or on the purchase order, sales order, or transfer order line.

To plan coverage for items that have an available inventory status, select the Coverage plan by dimensionCoverage plan by dimension

option for a storage dimension on the Storage dimension groupsStorage dimension groups  page. When you open the Item CoverageItem Coverage
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Change inventory statuses
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wizard, items that have an available status appear on the StatusStatus  page. To create coverage settings for these

items, select the inventory status ID for the available inventory statuses. Based on the coverage settings, you can

calculate the item requirements and forecast the supply and demand of available items during master planning.

You can't create an item coverage setup that has a blocked inventory status. Alternatively, use the ItemItem

coveragecoverage page to create or modify the item coverage parameters.

You can change inventory statuses either by using the On-hand by locationOn-hand by location page or by using the Inventory

status change periodic task.

When using the Inventory status change periodic task, you can select which records to include and set the

task to run in the batch at the desired interval.

To change inventory status as an ad-hoc process, go to On-hand by locationOn-hand by location page, select the relevant

records, and then select the Inventor y status changeInventor y status change button.

The Change the inventory status of items controlled by tracking dimensions feature allows you to change the inventory

status of items controlled by tracking dimensions, including the ability to update only selected records. Use feature

management to enable the feature as needed. When the feature is enabled, you'll be able to do the following:

On the On-hand by locationOn-hand by location page, you can group lines based on shown dimensions using the DisplayDisplay

dimensionsdimensions button and change the status for the selected lines.

On the On-hand by locationOn-hand by location page, you can select multiple records and then use the Inventor y status changeInventor y status change

button to change all of them at once.

On the Inventor y status changeInventor y status change periodic task you will be able to filter by tracking dimensions.
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Set the default location capacity

Define the location name format

Define warehouse locations

This topic describes how to set up information about the locations in a warehouse. This applies only to

warehouses created using "basic warehousing" in the Inventory management module, not to warehouses

created in the Warehouse management module. You can use this procedure in demo data company USMF, or on

your own data.

1. In the navigation pane, go to Modules > Inventor y management > Setup > Inventor y andModules > Inventor y management > Setup > Inventor y and

warehouse management parameterswarehouse management parameters .

2. Select the LocationsLocations  tab.

3. In the Standard widthStandard width field, enter a number.

4. In the Standard depthStandard depth field, enter a number.

5. In the Standard heightStandard height field, enter a number.

6. Select SaveSave.

7. Close the page.

1. In the navigation pane, go to Modules > Inventor y management > Setup > Inventor y breakdown >Modules > Inventor y management > Setup > Inventor y breakdown >

WarehousesWarehouses .

2. Select NewNew .

3. In the WarehouseWarehouse field, type a value.

4. In the NameName field, type a value.

5. In the S iteSite field, select the desired record in the lookup.

6. Toggle the expansion of the Location namesLocation names  section. The options in this section define the default format

for location names. In our example, we'll include the aisle number, rack number and shelf number.

7. Set the Include aisleInclude aisle option to YesYes .

8. Set the Include rackInclude rack option to YesYes .

9. In the FormatFormat field, for the rack, type a value.

10. Set the Include shelfInclude shelf  option to YesYes .

11. In the FormatFormat field, for the shelf, type a value.

1. On the Action Pane, select WarehouseWarehouse.

2. Select Location WizardLocation Wizard.

3. Select NextNext.

4. De-select the Outbound docksOutbound docks  option

5. De-select the Bulk locationsBulk locations  option

6. Select NextNext until you come to the option to select FinishFinish .

7. Close the page.

8. Refresh the page.
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This procedure shows you how to set up a new barcode definition which can then be used as part of the picking

list report. You can walk through this procedure in demo data company USMF, or using your own data. If you are

using USMF you can use the example values that are shown. These tasks would typically be carried out by a

warehouse manager.

1. Go to Bar codes.

2. Click New.

3. In the Barcode setup field, type a value.

4. In the Description field, type a value.

5. In the Bar code type field, select an option.

6. In the Size field, enter a number.

7. In the Maximum length field, enter a number.

8. Click Save.

9. Close the page.

10. Go to Inventory and warehouse management parameters.

11. In the Barcode setup field, enter or select a value.

12. Click Save.

13. Close the page.

If you're using USMF, you can select 'Code 39'.

Select the barcode setup that you created before, but be aware that the bar code format must match

the format of the unique identifier for the record type used in the process. For example, for picking

routes, the bar code format should match the format of the picking route reference, which is typically

a number sequence.

Can you tell us about your documentation language preferences? Take a short survey.
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Check on-hand inventory for an item

Check physical on-hand inventory

Check on-hand inventory by location

This procedure shows you how to check on-hand and physical on-hand inventory for a specific item number. It

also shows you how to get supply information related to an item. Physical on-hand inventory is the on-hand

inventory that's available – that is, it's purchased, received and registered. On-hand inventory includes the

available on-hand inventory, but also the inventory that's been ordered and is expected, but not yet received or

registered. You can walk through this procedure in demo data company USMF, or using your own data. If you

are using USMF you can use the example values that are shown. These tasks would typically be carried out by a

warehouse worker.

1. Go to Navigation pane > Modules > Inventor y management > Inquir ies and repor ts > On-handNavigation pane > Modules > Inventor y management > Inquir ies and repor ts > On-hand

inventor yinventor y .

2. Select the Item numberItem number  row. To query the on-hand inventory by item number, select the row where the

Table is set to On-hand inventor yOn-hand inventor y  and Field is set to ItemItem number.

3. In the Criter iaCriter ia field, select the item you want to query. If you're using the USMF demo data company, you

can select 'M9201'.

4. Click OKOK.

5. On the Action PaneAction Pane, click DimensionsDimensions . The DimensionsDimensions  tab allows you select how much detail you want

to see about your on-hand inventory. If you need data related to reservation, you must display all inventory

dimensions for the items that use advanced warehouse (WMS) processes.

6. Click OKOK.

7. On the Action PaneAction Pane, click Related informationRelated information. If you don't see this option, you may need to click on the

Ellipsis button (…) to see additional Action Pane options.

8. Click Supply over viewSupply over view . The Supply over viewSupply over view  tab provides supply information for a specific item, such as

the quantity on-hand, the lead time, and vendor information.

9. Expand the On-handOn-hand section.

10. Expand the VendorsVendors  section.

11. Close the page.

12. Close the page.

1. Go to Navigation pane > Modules > Warehouse management > Inquir ies and repor ts > PhysicalNavigation pane > Modules > Warehouse management > Inquir ies and repor ts > Physical

on-hand inventor yon-hand inventor y .

2. In the Item numberItem number  field, type a value. You can use the Site and Warehouse fields to filter the list of items.

3. Refresh the page.

4. On the Action PaneAction Pane, click Display DimensionsDisplay Dimensions . The Dimensions Display tab allows you select how much

detail you want to see about your on-hand inventory.

5. Click OKOK.

6. Close the page.

1. Go to Navigation pane > Modules > Warehouse management > Inquir ies and repor ts > On handNavigation pane > Modules > Warehouse management > Inquir ies and repor ts > On hand
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by locationby location.

2. In the WarehouseWarehouse field, type a value. If you're using the USMF demo data company, you can use '51'.

3. Refresh the page.

4. Click Display DimensionsDisplay Dimensions .

5. Click OKOK.

6. Close the page.
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Query your on-hand inventory

C O L UM NC O L UM N DESC RIP T IO NDESC RIP T IO N

Physical inventory The physical quantity that is available in inventory.

Physical reserved The total quantity that was physically reserved.

Available physical The available (not reserved) quantity that is available in
physical inventory.

Available physical on extra dimensions The available physical quantity for all the dimensions that are
shown in the grid.

Ordered in total The total quantity that is included on inbound orders or that
has a positive quantity in various inventory journals.

On order The total quantity that is included on outbound orders or
that has a negative quantity in various inventory journals.

This topic describes how to use the On-hand listOn-hand list page to inspect on-hand inventory details. It shows a few of

the ways that the various filtering and sorting options work together, and how those options can sometimes

produce unexpected results when they are combined.

To check the availability of inventory, go to Inventor y management > Inquir ies and repor ts > On-handInventor y management > Inquir ies and repor ts > On-hand

listlist.

The On-hand listOn-hand list page is automatically updated when transactions are made in inventory. Those transactions

might be forecasted, physical, or financial transactions.

Use the following tools to find the set of products that you're looking for :

On the Action Pane, select DimensionsDimensions  to open a dialog box where you can add or remove columns that are

shown in the On-handOn-hand grid.

In the FiltersFilters  pane, enter values for specific fields to show only records that match those values. Note that

filters that you define here apply to source tables that might be aggregated later, according to the dimensions

that you've selected to show. For information about how this behavior can affect your results, see the

examples later in this topic.

In the FiltersFilters  pane, select ApplyApply  to generate the list of matching on-hand inventory in the On-handOn-hand grid.

In the On-handOn-hand grid, select any column heading to sort or filter by values in that column. A QuickFilter at the

top of the grid provides additional filtering options. These filters apply to the results, not to the source tables.

For information about how this behavior can affect your results, see the examples later in this topic.

For each matching item, the On-handOn-hand grid provides the following columns of inventory information.

Available physicalAvailable physical is a calculated field. The value
equals the Physical inventor yPhysical inventor y  value minus the
Physical reser vedPhysical reser ved value.
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Ordered reserved The total quantity that is reserved on ordered receipts. The
value in this field represents the total quantity of items in
outbound transactions that have a status of Ordered
reserved. Items that are reserved as ordered aren't physically
available in inventory. Therefore, they can't be directly picked
and delivered.

Available for reservation The total quantity of on-hand inventory that can be
reserved.

Total available The total available quantity.

C O L UM NC O L UM N DESC RIP T IO NDESC RIP T IO N

Apply filters to find the records that you're looking for

IMPORTANTIMPORTANT

Select which dimensions to show

Note:Note:  If the Reser ve ordered itemsReser ve ordered items check box is
selected on the Inventor y and warehouseInventor y and warehouse
management parametersmanagement parameters  page, the value in this field
includes expected receipts. If the check box is cleared,
the value excludes expected receipts.

Total availableTotal available is a calculated field. The value equals
the Available physicalAvailable physical value plus the Ordered inOrdered in
totaltotal value minus the On orderOn order  value.

Use the FiltersFilters  pane to filter the on-hand inventory list so that it includes only records where the field values

match the filtering criteria. To define a filter, follow these steps.

1. In the FiltersFilters  pane, find the field that you want to filter on.

2. In the field below the name of the target field, select a logical operator (for example, starts with, equal to, or

greater than).

3. Enter or select the value to look for.

The On-hand listOn-hand list  page is assembled from a detailed on-hand inventory table that includes all available dimensions.

However, the list on this page is a summary. Therefore, it might combine rows from the source table by aggregating

values according to the dimensions that are shown.

The filters that you define in the FiltersFilters  pane apply to the source table, not to the aggregated list. This behavior can

sometimes produce unexpected results. For information about how this behavior can affect your results, see the examples

later in this topic.

However, the filters that are provided in the grid do apply to the aggregated list. These filters include both the QuickFilter

at the top of the grid and the filter for each column heading.

You can modify the set of filters that is available in the FiltersFilters  pane by following these steps.

To remove a filter from the pane, select its CloseClose button (XX).

To add a filter, select AddAdd at the top of the FiltersFilters  pane. The Add filter  fieldsAdd filter  fields  dialog box that appears shows

a list of the available fields. It also shows information about the data type and table for each field. Use the

column headings to filter and sort the list as you require, and then select the check box for each field that you

want to add to the FilterFilter  pane. When you've finished, select Inser tInser t to apply your changes.



  

      

Filter on the output of the inventory on-hand list
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Examples
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IA0001 1 1 1 1

IA0001 1 2 2 2

IA0001 1 3 1 1

Scenario 1Scenario 1

Dimensions tell you more about each item in the on-hand inventory list, and give you more ways to sort and

filter the list. The dimensions that you select to show also affect how rows are aggregated on the On-hand listOn-hand list

page. This aggregation, in turn, can affect how rows from the source tables are combined in the results that you

see. For information about how this behavior can affect your results, see the examples later in this topic.

To customize the selection of inventory dimensions that is shown, follow these steps.

1. On the Action Pane, select DimensionsDimensions .

The Dimension displayDimension display  dialog box that appears shows every dimension.

2. Select the check box for each dimension that you want to include in the grid.

3. If you want your selection to be used by default the next time that you open the On-hand listOn-hand list page, set

the Save setupSave setup option to YesYes . If you set this option to NoNo, your selection will be used only during the

current session. Therefore, the next time that you open the page, the current default selection will be

used.

4. Select OKOK to close the dialog box and apply your changes.

You can select any column heading in the On-handOn-hand grid to sort or filter by values in that column. A QuickFilter

at the top of the grid provides additional filtering options. These filters apply to the results, not to the source

tables. For information about how this behavior can affect your results, see the examples later in this topic.

You can't filter and sort by all columns. Most of the quantity columns don't include sorting and filtering controls, because

they are calculated fields. The On orderOn order  column is an exception.

Your system includes a detailed (non-aggregated) inventory table that shows the following on-hand inventory.

The On-hand listOn-hand list page is set up to show the following final dimensions:

Item number

Site

Warehouse

In the FiltersFilters  pane, the following filtering criteria are set up:

Item NumberItem Number  | is exactlyis exactly  | IA0001

Available PhysicalAvailable Physical  | less than or equalless than or equal  | 1
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IA0001 1 1 1 1

IA0001 1 3 1 1

Scenario 2Scenario 2
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IA0001 1 2 2
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Here is the resulting output.

The On-hand listOn-hand list page is set up to show the following final dimensions:

Item number

Site

In the FiltersFilters  pane, the following filtering criteria are set up:

Item NumberItem Number  | is exactlyis exactly  | IA0001

Available PhysicalAvailable Physical  | less than or equalless than or equal  | 1

Here is the resulting output.

Note that the settings in the FiltersFilters  pane apply to the detailed (non-aggregated) inventory table that is shown

at the beginning of this section. Therefore, the criterion Available PhysicalAvailable Physical  | less than or equalless than or equal  | 1 finds two

rows from that table (the first and third rows, each of which shows an Available PhysicalAvailable Physical  value of 1). However,

in this scenario, the On-hand listOn-hand list page isn't set up to show the WarehouseWarehouse dimension. Therefore, it aggregates

the two original rows into a single resulting row, because both rows have identical values in all the dimensions

that are shown. This row appears to violate the filtering criterion, because the Available PhysicalAvailable Physical  value is

shown as 2. However, the result is correct, because the settings in the FiltersFilters  pane apply to the source table, not

to the aggregated table that is shown on the On-hand listOn-hand list page.
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This procedure shows you how to get the on-hand inventory updated manually using an Inventory movement

journal. (It's also possible to update on-hand inventory by importing transactions in data entities.) You can run

this guide in demo data company USMF where all the prerequisites like journal name, item setup, posting

profiles, and accounts are available. The guide suggests specific values for the item and dimensions that are

used. If you choose a different item, you may need to enter values for different dimensions.

1. Go to Inventory management > Journal entries > Items > Movement.

2. Click New.

3. In the Name field, click the drop-down button to open the lookup.

4. Select IMov.

5. In the list, click the link in the selected row.

6. In the Offset account field, specify the values '140200'.

7. Click OK.

8. Click New.

9. In the Item number field, click the drop-down button to open the lookup.

10. Select item A0001.

11. In the list, click the link in the selected row.

12. Click the Inventory dimensions tab.

13. In the Site field, click the drop-down button to open the lookup.

14. Select site 1.

15. In the Warehouse field, click the drop-down button to open the lookup.

16. Select warehouse 13.

17. In the list, click the link in the selected row.

18. In the Location field, click the drop-down button to open the lookup.

19. Select location 13.

20. In the Quantity field, enter a number.

21. Click Save.

22. Click Post.

23. Check or uncheck the Transfer all posting errors to a new journal check box.

24. Click OK.

25. Close the page.

26. Close the page.

It's a good practice to use different journal name templates for the different business purposes.

This is the offset account that will be the default account on the journal lines. It's possible to override

the default to assign different offset accounts per line.

If you enable this option, any lines that fail to post will be copied to a new journal. You can use the

information in the log to correct the issues and then re-post the lines.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/tasks/initialize-stock-levels-warehouse.md
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Create an inventory transfer journal

Create journal lines

Post the inventory transfer journal

View inventory transactions

This procedure walks you through the process of creating and posting an inventory transfer journal in order to

register movement of an item from one location in a warehouse to another. You need to have an inventory

journal name set up for inventory transfers before you start this. You can walk through this procedure in demo

data company USMF using the example values that are shown, or using you can use your own data if you have

products and locations set up. These tasks would normally be carried out by a warehouse employee.

1. In the Navigation paneNavigation pane, go to Inventor y management > Journal entr ies > Items > TransferInventor y management > Journal entr ies > Items > Transfer .

2. Click NewNew .

3. In the NameName field, enter or select a value.

4. Click OKOK. There is the option to specify 'From' and 'To' dimensions for each journal line. These are essential

for this journal type. You can transfer items to locations using different rules. In this example we'll transfer an

item within the same warehouse, from a license plate controlled location to a location that is not license plate

controlled.

1. Int the Journal lines fastTabJournal lines fastTab, click NewNew .

2. In the Item numberItem number  field, enter or select a value. If you are using USMF, you can select 'A0001'.

3. In the From siteFrom site field, enter or select a value. If you are using USMF, you can select '2'.

4. In the To siteTo site field, enter or select a value. If you are using USMF, you can select '2'.

5. In the From warehouseFrom warehouse field, enter or select a value. If you are using USMF, you can select '24'.

6. In the To warehouseTo warehouse field, enter or select a value. If you are using USMF, you can select '24'.

7. In the From locationFrom location field, enter or select a value. If you are using USMF, you can select 'FL-001'.

8. In the To locationTo location field, enter or select a value. If you are using USMF, you can select 'BULK-001'.

9. In the QuantityQuantity  field, enter a number.

10. In the L ine detailsL ine details  fastTab, click the Inventor y dimensionsInventor y dimensions  tab.

11. In From inventor y dimensionsFrom inventor y dimensions , in the L icense plateLicense plate field, enter or select a value. If you are using USMF,

you can select '24'.

12. Click SaveSave.

1. On the Action PaneAction Pane, click PostPost.

2. Click OKOK.

1. Click Inventor yInventor y .

2. Click TransactionsTransactions . Here you can see the transactions that were created when you posted your journal.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/tasks/transfer-physical-inventory-within-warehouse.md
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Create an inventory adjustment journal

Create journal lines

Validate and post the inventory adjustment journal

This procedure walks you through the process of creating and posting an inventory adjustment journal in order

to adjust stock levels of products in the warehouse. You need to have an inventory journal name set up for

inventory adjustments before you start this. You can walk through this procedure in demo data company USMF,

or using your own data. These tasks would normally be carried out by a warehouse employee.

1. Go to Inventory management > Journal entries > Items > Inventory adjustment.

2. Click New.

3. In the Name field, click the drop-down button to open the lookup.

4. In the list, click on the inventory adjustment journal name you want to use.

5. Click OK.

Some other fields will be populated based on the setup of the inventory adjustment journal name you

select.

1. Click New.

2. In the list, mark the item number field.

3. In the Item number field, Select an item. If you are using demo data company USMF, type 'D0001'.

4. In the Site field, click the drop-down button to open the lookup.

5. In the list, select a site.

6. In the Warehouse field, click the drop-down button to open the lookup.

7. In the list, select a warehouse.

8. In the Quantity field, enter a number.

If you have selected an item with Location as a mandatory dimension, you would have to specify the

location here.

The cost price field specifies the cost per unit for inventory receipts. If the cost is not specified for the

item number or if you wanted to change it manually, you would do this here.

1. Click Validate.

2. Click OK.

3. Click Post.

4. Click OK.

5. Close the form.

6. Close the page.

When you post this kind of journal, an inventory receipt or issue is posted, the inventory level and

value are changed, and ledger transactions are generated.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/tasks/adjust-stock-levels-warehouse-basic-warehousing.md
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Additional resources

NOTENOTE

This topic provides information about tag counting, which you use to compare the actual contents of a

warehouse with the on-hand inventory.

By creating lines on the Tag countingTag counting page, you place a tag number on each inventory item, such as a number

from 1 to 500. During the count, you enter the item number and the quantity on a corresponding tag. This tag

can then be used as the basis for input in the tag counting journal. After you post the tag counting journal, a new

counting journal is created on the CountingCounting page. The new journal is based on the tag counting journal lines

that you created. To tag-count items by a specific inventory dimension, select the dimension on the DisplayDisplay

dimensiondimension page that is displayed when you create the tag counting journal. For example, to count items in a

specific warehouse, select the WarehouseWarehouse check box. If the Lock items during countLock items during count slider on the Inventor yInventor y

and warehouse management parametersand warehouse management parameters  page is selected, items can't be physically updated during

counting. However, items in tag counting journals aren't locked during counting. Inventory transactions aren't

created until the tag counting lines are posted and transferred to a counting journal. If tags are entered

randomly, and you want to identify missing tags, click the TagTag column header to sort the lines by tag.

Cycle counting

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create an inventory counting journal

Create journal lines

Post the inventory counting journal

View inventory transactions

This topic describes the process of creating and posting an inventory counting journal in order to count a

specific item at a location in the warehouse. The procedure applies to "basic warehousing" functionality,

available in the Inventory management module, not to the warehousing functionality that's available in the

Warehouse management module. You can walk through this procedure in demo data company USMF, or using

your own data. If you're using your own data, make sure that you have products and locations set up, and that

you've created an inventory journal name for counting journals. Inventory counting is normally carried out by a

warehouse employee.

1. Go to Navigation pane > Modules > Inventor y management > Journal entr ies > Item counting >Navigation pane > Modules > Inventor y management > Journal entr ies > Item counting >

CountingCounting.

2. Select NewNew .

3. In the NameName field, select the inventory counting journal name you want to use from the drop-down list.

Some other fields will be populated based on the setup of the inventory counting journal name that you

select.

4. In the WorkerWorker  field, select the drop-down button to open the lookup.

5. In the list, SelectSelect the worker you want to use.

6. Select OKOK.

1. Select NewNew .

2. In the Item numberItem number  field, select the desired record from the drop-down list. If you are using demo data

company USMF, select A0001A0001 .

3. In the S iteSite field, select the desired record from the drop-down list. If you are using demo data company

USMF, select site 22 .

4. In the WarehouseWarehouse field, select the desired record from the drop-down list. If you are using demo data

company USMF, select warehouse 2424 .

5. In the LocationLocation field, select the desired record from the drop-down list. If you are using demo data company

USMF, select location BULK-001BULK-001 .

6. In the Counted field, enter a number. If you enter a counted number that's different to the number shown in

the On-handOn-hand field, the QuantityQuantity  field is updated to show the discrepancy.

7. Select SaveSave.

1. Select PostPost. When you post an inventory counting journal, if the counted amount differs from amount that's

reported in the On-handOn-hand field an inventory receipt or issue is posted, the inventory level and value are

changed, and ledger transactions are generated.

2. Select OKOK.

1. Select Inventor yInventor y .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/tasks/count-inventory-warehouse.md
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2. Select TransactionsTransactions . Here you can see any related transactions that will be created when you post your

inventory counting journal.

Can you tell us about your documentation language preferences? Take a short survey.
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Create a counting group

Create a counting journal name

This topic describes the configuration of basic inventory counting processes by creating a counting group and a

counting journal. It also shows you how to enable counting policies on a warehouse and item level. These tasks

would typically be carried out by a warehouse supervisor. It is a prerequisite to have some existing released

products and warehouses. If you're using a demo data company, you can run this procedure in the USMF

company with any stocked item.

1. In the navigation pane, go to Modules > Inventor y management > Setup > Inventor y >Modules > Inventor y management > Setup > Inventor y >

Counting groupsCounting groups .

2. Select NewNew .

3. In the Counting groupCounting group field of the new row, type a value.

4. In the NameName field, type a value.

5. In the Counting codeCounting code field, select an option.

ManualManual  – Includes lines every time you run the job. In other words, you decide the counting interval

for the counting group.

PeriodPeriod – Includes lines for the period in the counting journal when the period interval has expired.

Zero in stockZero in stock – If on-hand inventory reaches zero (0), lines are generated in the counting journal

when the job is run. If the on-hand inventory reaches 0 after a count, lines are generated the next time

that you start the count.

MinimumMinimum – Inserts lines in the counting journal if the on-hand inventory is equal to or less than the

minimum that is specified.

Optional: If you have specified PeriodPeriod in the Counting codeCounting code field, you must type the interval for the

period in the Counting periodCounting period field. The unit for intervals is days.

When you run the job for creating new lines in the counting journal, new lines are created at the

interval specified in this field, regardless of how often you run the same job. For example, if CountingCounting

periodperiod is set to 7, and journal lines were last generated for a count on January 1, if another job is

started on January 5, seven days have not passed and so no lines are generated in the journal for that

period interval. If you start the job again on January 8, lines are generated for the period in the

counting journal, because 7 days have passed.

6. Select SaveSave.

1. In the navigation pane, go to Modules > Inventor y management > Setup > Journal names >Modules > Inventor y management > Setup > Journal names >

Inventor yInventor y .

2. Select NewNew .

3. In the NameName field, type a value.

4. In the Descr iptionDescr iption field, type a value.

5. In the Journal typeJournal type field, select CountingCounting. Optional: you can select a different voucher series ID if you

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/tasks/define-inventory-counting-processes.md


Set standard counting journal name

Set the counting policy for an item

Set the counting policy for an item in a specific warehouse

want a specific number sequence for the voucher IDs generated when creating counting journals.

Voucher series are created in the Number sequencesNumber sequences  page.

6. In the Detail levelDetail level  field, select an option.

This is the level of detail that is applied when the journal is posted.

Optional: you can change the value in the Reservation field. This is the method used to reserve items

during counting.

ManualManual  – The items are reserved manually in the Reservation form.

AutomaticAutomatic – The order quantity is reserved from the available, on-hand inventory for the item.

ExplosionExplosion – The reservation is part of the master planning of the transaction.

7. Select SaveSave.

1. In the navigation pane, go to Modules > Inventor y management > Setup > Inventor y andModules > Inventor y management > Setup > Inventor y and

warehouse management parameterswarehouse management parameters .

2. Select the JournalsJournals  tab.

3. In the drop down menu of the CountingCounting field, select the journal you previously created. This journal will

then be the default journal name for inventory journals of the CountingCounting type.

4. Select the GeneralGeneral  tab. Optional: Select this option to lock an item during the counting process to prevent

updates for packing slips, picking lists, or picking list registrations.

1. In the navigation pane, go to Modules > Product information management > Products > ReleasedModules > Product information management > Products > Released

productsproducts .

2. In the list, select the link for the Item number of the product that you want to set counting policies on. You

must select an item that is inventory tracked. A non-stocked product can't be counted. If you are using USMF

demo data you can select item A0001.

3. Select EditEdit.

4. Toggle the expansion of the Manage inventor yManage inventor y  section.

5. In the drop-down menu of the Counting groupCounting group field, select the counting group you previously created. This

product will now be included when inventory counting journal lines are created using this counting group.

6. Select SaveSave.

1. On the Action Pane, select Manage inventor yManage inventor y .

2. Select Warehouse itemsWarehouse items .

3. Select NewNew .

4. In the drop-down menu of the WarehouseWarehouse field, select the warehouse you want to set up specific counting

policies for.

5. In the drop-down menu of the Counting groupCounting group field, select a counting group. You can select a specific

counting group that should apply to the item in the specific warehouse you have selected. When counting is

performed in that warehouse, this counting policy will override the general counting policy for the item.

6. Select SaveSave.



NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Set up consignment
2/18/2021 • 6 minutes to read • Edit Online

Overview of the consignment process

This topic explains how to use the inbound consignment inventory processes.

Consignment inventory is inventory that’s owned by a vendor, but stored at your site. When you’re ready to

consume or use the inventory, you take over the ownership of the inventory. This topic includes information

about how to physically receive vendor-owned inventory on-hand without creating general ledger transactions,

how to start a production process where the vendor-owned inventory can be physically reserved. and how to

change the ownership of the raw material in order to be able to process the consumption as part of the

production order processing. There’s also some information about how vendors can monitor consumption of

their inventory using the vendor collaboration interface.

In this example scenario, company USMF has a consignment agreement with vendor US-104 for the raw

material M9211CI.

1. A consignment replenishment order is manually created by someone in USMF, based on the expected

demand. The order is created for vendor US-104 and a line is added for item MS9211CI.

2. The vendor gets informed about the expected delivery. This can happen in one of three ways:

3. The inventory is delivered from US-104 to USMF.

4. When the material arrives at USMF, the consignment replenishment order is updated with a product receipt.

Only the physical quantities of the vendor-owned inventory are recorded. There are no general ledger

transactions created, because the inventory is still owned by the vendor.

5. The vendor monitors updates to the physical on-hand inventory using the On-hand consignmentOn-hand consignment

inventor yinventor y  page.

6. Now that the physical inventory is on-hand, the production process reserves the vendor-owned inventory

and starts the production order for the finished goods that are going to consume the raw material M9211CI.

7. The owner of the reserved raw materials that are going to be consumed in today’s production is changed

from US-104 to USMF. This is done using an Inventory ownership change journal. This process creates

purchase orders where the OriginOrigin field is set to ConsignmentConsignment.

8. The vendor monitors the consumption (change of ownership) on the Products received fromProducts received from

consignment inventor yconsignment inventor y  page and issues an invoice based on the agreements between the two companies.

9. The production process consumes the raw material via a production picking list. The physical reservation is

automatically updated to reflect that the on-hand inventory is owned by USMF.

10. The invoice from US-104 is processed against the purchase orders which were auto-generated when the

inventory ownership change journal was processed. Payment is made to vendor US-104 for the inventory

that was consumed.

Someone working at USMF sends the order information to the vendor.

The vendor can monitor the expected inventory on-hand using the vendor collaboration interface.

Someone working at USMF filters the data on the On-hand inventor yOn-hand inventor y  page to show only the

records for vendor US-104, where the receipt status is OrderedOrdered, and then sends this information to

the vendor.

USMF carries out additional periodic processes:

The physical movement of the vendor-owned inventory between different warehouses is processed using a

transfer journal.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/consignment.md


Consignment replenishment orders

Inventory ownership change journal

The physical inventory on-hand is updated using an Item countingItem counting journal. Counting can also be used by

the vendor to update the on-hand inventory, if they have permission to do this.

The vendor, US-104, can monitor the updates using the On-hand consignment inventor yOn-hand consignment inventor y  page.

A consignment replenishment order is a document that is used to request and keep track of inventory quantities

of products that a vendor intends to deliver within a certain date interval by creating ordered inventory

transactions. Typically, this will be based on the forecast and actual demand of the specific products. The

inventory that’s going to be received against the consignment replenishment order remains in the ownership of

the vendor. Only the possession of the products related to the physical receipt update is recorded and therefore

no general ledger transaction updates occur.

The OwnerOwner  dimension is used to separate information about which inventory is owned by the vendor and

which is owned by the receiving legal entity. Consignment replenishment order lines have an Open orderOpen order

status as long as the full quantity of the lines has not been received or cancelled. When the full quantity has

been received or canceled, the status is changed to CompletedCompleted. The physical on-hand inventory that’s related to

a consignment replenishment order can be recorded using a Registration process as well as a Product receipt

update process. Registration can be done as part of the item arrival process or by manually updating the order

lines. When the Product receipt update process is used, a record is made in the product receipt journal, which

can be used to acknowledge the receipt of goods to the vendors.

The process of changing the owner of the inventory from the vendor to the receiving legal entity is done using

an Inventory ownership change journal. No expected inventory transactions are created for the journal. The only

inventory transactions created are those that relate to a posted journal. When the journal is posted:

The vendor-owned inventory is issued using an Ownership changeOwnership change reference with a SoldSold status.

On-hand inventory is received by the legal entity that’s consuming it using a product receipt updated

inventory transaction on the purchase order. This sets the status of the order to ReceivedReceived. Purchase orders

used for consignment have the OriginOrigin field set to ConsignmentConsignment.

It’s not possible to update the quantity on consignment purchase order lines after the order has been created.

file:///T:/eiye/ac1a/dynamics365/supply-chain/inventory/media/consignment-replenishment-order.png


Vendor collaboration in consignment processes

Inventory owners

Tracking dimension group

The vendor collaboration interface has three pages related to the inbound consignment process:

Purchase ordersPurchase orders  consuming consignment inventor yconsuming consignment inventor y  - Shows detailed purchase order information

related to the ownership change from the consignment process.

Products received from consignment inventor yProducts received from consignment inventor y  - Shows information about the items and quantities

that have product receipts updated during the ownership change process.

On-hand consignment inventor yOn-hand consignment inventor y  - Shows information about the consignment items that they are

expected to deliver, and the items that are already physically available at the customer site.

In order to record physical inbound consignment inventory, you need to define a vendor owner. This is done on

the Inventor y ownerInventor y owner  page. When you select a Vendor accountVendor account this generates default values for the NameName

and OwnerOwner  fields. The value in the OwnerOwner  field will be visible to the vendor, so you might want to change it if

your vendor account names aren’t easy for external people to recognize. It’s possible to edit the OwnerOwner  field,

but only up to the point when you save the Inventor y ownerInventor y owner  record. The NameName field is populated with the

name of the party that the vendor account is associated with, and this cannot be changed.

Items that are going to be used in consignment processes must be associated with a Tracking dimensionTracking dimension

groupgroup where the OwnerOwner  dimension is set to ActiveActive. The Owner dimension always has the PhysicalPhysical

inventor yinventor y  and Financial inventor yFinancial inventor y  options selected. The Coverage plan by dimensionCoverage plan by dimension is never selected.
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Inventory ownership change journal

Vendor collaboration in consignment processes

NOTENOTE

The Inventor y ownership changeInventor y ownership change journal is used to record the transfer of ownership of consignment

inventory from the vendor to the legal entity that’s consuming it. Like any inventory journal, it must be

identified with an Inventory journal name. These names are created on the Inventor y journal namesInventor y journal names  page,

and the Journal typeJournal type must be set to Ownership changeOwnership change.

If your vendors are using the vendor collaboration interface, they can use this to monitor the consumption of

inventory at your site. For more information about setting up vendors to use vendor collaboration, see Vendor

portal user security.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create an inventory ownership journal

Post the inventory ownership change journal

This procedure shows how to change the owner of consignment inventory from the vendor to your legal entity

when there is demand for the inventory in production. This change of ownership is done by creating and

posting an inventory ownership change journal. The ownership change journal lines can be created manually or,

as shown in this recording, based on existing production demand. Typically, a shop floor supervisor performs

this task. You can use this procedure in the USMF demo data company or on your own data. If you're using your

own data, make sure that you have the following prerequisites: an inventory journal name that has been set up

for inventory ownership change, physically recorded vendor-owned on-hand items, and one or more

production order lines for the material. This procedure is for a feature that was added in Dynamics 365 for

Operations, version 1611.

Outbound consignment processes are not supported out-of-the-box and automatic ownership journal processing is not

supported.

1. Go to Inventory management > Journal entries > Items > Inventory ownership change.

2. Click New.

3. In the Name field, enter or select a value.

4. Click OK.

5. Click Functions.

6. Click Create journal lines from production orders.

7. In the Inventory issue statuses to include field, select an option.

8. Expand the Records to include section.

9. Click OK.

The inventory ownership change journal is used to change the owner of consignment inventory from

the vendor to the current legal entity. This change of ownership is done by releasing the on-hand

inventory that is owned by the vendor and then receiving that inventory in the current legal entity.

You can select only inventory journal names that have a journal type of Ownership change.

You can start the change of ownership process by querying all the production lines that have demand

for consumption of raw material.

This option lets you filter by the issue status of the inventory transactions. For example, you can create

journal lines for inventory that has the Picked and Reserved physical statuses.

This section lets you apply additional filtering. For example, you can select a specific raw material date.

1. Click Post.

When the journal is posted, the vendor-owned inventory is released by using an "Ownership change"

reference. The inventory is then received as on-hand by using an inventory transaction that is updated

with a purchase order product receipt. Note that only transactions that are related to the posted

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/tasks/change-ownership-consignment.md
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2. Click OK.

3. Close the page.

journal are created. No expected inventory transactions are created.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a consignment replenishment order

Check the inventory transaction status

Receive items

Check the on-hand inventory

This topic explains how to create a consignment replenishment order where you can track the expected delivery

from a vendor into your consignment inventory. It also shows how to record a receipt of products so that the

consignment inventory is registered as on-hand inventory owned by the vendor. This procedure would typically

be done by a procurement professional. You can use this guide in demo data company USMF. This procedure is

for a feature that was added in Dynamics 365 for Operations, version 1611.

1. In the navigation pane, go to Modules > Procurement and sourcing > Consignment > ConsignmentModules > Procurement and sourcing > Consignment > Consignment

replenishment ordersreplenishment orders .

2. Select NewNew .

3. In the Vendor accountVendor account field, select vendor US-104US-104  (you must select a vendor that's registered as an owner

in the inventor y ownersinventor y owners  page).

4. Select OKOK.

5. Select Add lineAdd line.

6. In the Item numberItem number  field, type M9211CI  (you must select an item that is set up for consignment inventory).

7. In the QuantityQuantity  field, enter a number.

8. In the Requested deliver y dateRequested deliver y date field, enter a date. The requested and confirmed dates are used by the MRP

engine for the expected arrival of the goods.

9. In the Confirmed deliver y dateConfirmed deliver y date field, enter a date.

10. Expand the L ine detailsL ine details  section.

11. Select the Inventor y dimensionsInventor y dimensions  tab.

12. To show the owner in the Inventor y dimensions ownerInventor y dimensions owner  field, refresh the page. Vendor US-104 is now

listed as the owner.

1. Select Inventor yInventor y .

2. Select TransactionsTransactions .

3. In the desired row, notice that the ReceiptReceipt field is set to OrderedOrdered.

4. Close the page.

1. Select Product receiptProduct receipt.

2. In the External product receiptExternal product receipt field, type a value.

3. In the QuantityQuantity  field, enter a number that's lower than the number that's shown there.

4. Select OKOK.

1. Select Inventor yInventor y .

2. Select On-handOn-hand.

3. Select Over viewOver view . The items that have been received as consignment inventory owned by the vendor are

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/tasks/create-consignment-replenishment-order.md
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available on-hand. The remaining quantity on the consignment replenishment order is shown in the

Ordered in totalOrdered in total  field.

4. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Monitor consignment inventory using vendor
collaboration
2/18/2021 • 2 minutes to read • Edit Online

View consumed inventory

View on-hand inventory

NOTENOTE

This procedure shows how to use vendor collaboration to see information about the stock level of product that

you have placed in consignment with a customer. You can also monitor the consumption of the stock when the

customer takes ownership of the inventory. You can use this procedure in the USMF demo data company. This

procedure is for a feature that was added in Dynamics 365 for Operations, version 1611.

1. Go to Vendor collaboration > Consignment inventory > Products received from consignment inventory.

2. Click View purchase order.

3. Expand the Line details section.

4. Close the page.

The list shows the product receipt lines that were generated when ownership of the consignment

inventory was changed from the vendor to the customer. You might have to scroll to the right to see

quantities and other information. You can use the information in this list to generate invoices for your

customer. You can also export the data to Microsoft Excel.

The line is marked as Consignment, and the header section shows that the purchase order has a status

of Received.

1. Go to Vendor collaboration > Consignment inventory > On-hand consignment inventory.

The On-hand consignment inventory page shows the stock that you own at the customer's

warehouse. You can show additional dimensions, such as the site and warehouse, by clicking the

Display dimensions tab.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/tasks/monitor-consignment-inventory-vendor-collaboration.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Item and raw material tracing in inventory,
production, and sales
2/18/2021 • 10 minutes to read • Edit Online

What is item tracing?

What can I trace, and are there any limitations?

What criteria can I specify for an item trace?
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This topic describes how you can use item tracing to identify where items or raw materials have been used, are

being used, or will be used in production and sales processes.

Item tracing functionality is available on the Item tracingItem tracing page. The following sections describe how you can

use item tracing, and what the options and limitations are.

Item tracing is a business intelligence (BI) tool that provides visibility into the source and destination of items

and raw materials in the supply chain. Manufacturers can trace items, raw materials, or ingredients back to the

vendor, and forward through the production and sale of the finished product. Item tracing helps manufacturers

comply with regulatory requirements, and also helps quality officers and production managers analyze and take

action to address variances in the quality of products and materials. Here of some examples of the ways that

manufacturers can use item tracing:

Identify the amount of an item or raw material that is currently in inventory, and where it's stored.

Determine how much of the item or raw material has been shipped, and which customers it was shipped to.

Identify any planned shipments that include the item or raw material.

Locate production orders that use the item or raw material, and that are planned, in progress, or reported as

finished.

Find out where the item or raw material was purchased.

Investigate where an item or raw material was consumed in the production of another item.

You can trace historical inventory transactions for items and raw materials, based on an item number and a

tracking dimension, such as a serial number, batch number, or vendor batch number. You can trace an item or

raw material only if a tracking dimension is assigned to it. Because tracing is based on inventory transactions,

there are some limitations when you trace items. For example, there are limitations that are related to

transactions for projects, fixed assets, and commerce. Additionally, co-products are shown in the trace details,

but by-products aren't included. The trace includes all warehouse transactions from one location to another.

Therefore, users might find the amount of information overwhelming. The trace is displayed for one legal entity

at a time. There are no cross-company capabilities in an intercompany context. You must start a new trace for

each company where an item is received or issued.

The criteria that are required for an item trace are the item number, a tracking dimension (such as a batch

number or serial number), and the direction. The following table describes the criteria that you can use in an

item trace.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/trace-items-raw-materials-inventory-production-sales.md


Item number Enter the identifier for the item or raw material that you’re
tracing.

Product dimensions Optional: Trace specific aspects of the product definition,
such as a configuration, size, color, or style.

Tracking dimensions Enter a batch number, vendor batch number, or serial
number tracking dimension. When you use the batch
number as a criterion, the vendor batch number is displayed
if you’ve captured that information.

Storage dimensions Optional: Trace items that have been stored in a specific
location.

Period Optional: Enter dates to limit the trace to a specific period.
The trace details will show only documents and transactions
that were created between these dates.

Forward or backward Select the direction for the trace. You can trace forward or
backward:
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What information is included in the trace details?

Why don’t some nodes contain any details?

Can I view only a particular type of document? For example, can I
view only production orders, customers, or vendors?

BackwardBackward – Trace downstream to identify the
source, the quantity that remains on hand, and any
production orders that are at least partially reported
as finished.

For wardFor ward – Trace upstream to identify the
destination. You can find the sales orders, and the
customers that the traced item or raw material has
been at least partially shipped to.

The results of a trace appear in chronological order in the tree on the DetailsDetails  FastTab of the Item tracingItem tracing page.

The order varies, depending on the trace direction. The details include all transactions from the purchase of the

item from the vendor to the sale of the item to the customer. Trace results also include interim products that are

related to the item or the tracking dimension that was specified in the trace criteria. The top node shows the

quantity of the item, in the inventory unit, that remains on hand, based on the storage dimensions that were

specified in the trace criteria. Note:Note: The trace details provide a snapshot of the information that was available

when the trace was done. The trace details aren't updated if the information changes after the trace is done.

To reduce the amount of information in the trace details, only the node for the first instance of the item or raw

material includes details. If a selected node doesn’t contain details, you can view the node that does contain

details by clicking Go to traced lineGo to traced line. You can then return to the node that you left by clicking Go backGo back .

Yes, from the trace details, you can open list pages that include only a particular type of document or

transaction. You can access these pages from the TracingTracing menu item on the Action Pane, in the ItemItem, SalesSales ,

PurchasePurchase, ProductionProduction, and QualityQuality  groups. For example, to view a list of the vendors in the trace details, click

TracingTracing > PurchasePurchase > VendorsVendors . The list pages summarize the documents or transactions from the trace
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Not shipped sales orders View sales order lines that haven’t been picked, and that
therefore aren't shown in the trace details.

Pending orders View all pending production orders for the traced item,
regardless of the tracking dimensions that were used in the
trace criteria. You can also view pending production orders
where the traced item is an ingredient, and where no
registrations have been made and no transactions are
reported as finished for the order.

Pending transactions View pending inventory transactions for the traced item that
includes the specified tracking dimensions or a blank
tracking dimension. You can also view pending inventory
transactions for items and tracking dimension combinations,
or a blank value, in the trace details.

How many levels can I trace up or down in a BOM or formula?

How can I view more details about a document or transaction in the
trace details?

Can I run more than one trace and then compare the details?

details. The Pending transactionsPending transactions , Pending ordersPending orders , and Not shipped sales ordersNot shipped sales orders  list pages also show

other information that isn't included in the trace details. Additionally, they always show results as of the current

date, even if a date range was specified. The following table describes the additional details that these pages can

include.

You can trace one level up or down in a bill of materials (BOM) or formula. For example, if you run a trace on

raw materials, you can see the finished product and any co-products. However, if you trace a co-product, the

trace details don't include the finished product.

On the DetailsDetails  FastTab, there are two ways to view more information about a selected document or transaction

in the trace details:

When you select a node in the trace details on the DetailsDetails  FastTab, the other FastTabs on the page display

information about the document or transaction in the node.

Open the details page for the document in a selected node by clicking View detailsView details . For example, if you

select a node that describes a production order, and you click View detailsView details , the Production orders detailsProduction orders details

page appears.

Some FastTabs give you access to additional information about the selected node. For example, on the NonNon

conformancesconformances  FastTab, you can click Inquir iesInquir ies  to investigate whether there is a history of non-conformance.

On the BatchBatch FastTab, you can click On-hand listOn-hand list to view the amount of physical inventory that is currently on

hand and any inventory transactions that involve the batch.

After you run the trace, you can use the following options on the Trace from nodeTrace from node button to run a new trace

on the transaction in the selected node:

BackwardBackward or For wardFor ward – Start a new trace for the selected node, and overwrite the details of the current

trace.

New backwardNew backward or New for wardNew for ward – Start a new trace in a new window, and keep the details of the current

trace.



Can I save the trace details?

Can I calculate a balance for a particular item or ingredient?

Can I investigate whether there is a history of issues with items or raw
materials?

Are there any reporting capabilities that are related to item tracing?

Can I trace coproducts and byproducts?

NOTENOTE

If you want to use the New backwardNew backward or New for wardNew for ward option, you must use the Open in a new windowOpen in a new window

functionality to have a new trace appear in a new window.

You can save the information on the DetailsDetails  tab as an XML file by clicking Expor tExpor t below the TracingTracing action on

the Action Pane. In addition to the trace details, the XML file includes the trace criteria, parent node, and on-hand

quantity. The capability to save the details of a trace is useful if, for example, you want to attach the information

to a quality order or other compliance documentation. You can specify where the file is saved. To view the file

immediately, select the Show documentShow document option. Note:Note: The file is always saved, even if you only want to view it.

By default, the XML file opens in a browser window. However, you can right-click the file, select Open withOpen with , and

then select the program to use to display the contents.

You can export the information from the summary pages to Microsoft Excel. Open the relevant page, click the

Open in Microsoft OfficeOpen in Microsoft Office icon, and then select Expor t to Microsoft ExcelExpor t to Microsoft Excel . This functionality is especially

useful when you want to calculate a mass balance for an item or ingredient from the Transactions summar yTransactions summar y

page. On the Transactions summar yTransactions summar y  page, you can filter on the item or ingredient, and optionally on the

batch, and then export the information to Excel. In Excel, you can isolate, for example, the on-hand quantity, the

quantity that was sold, and the amount that was used in production.

The trace details include information about quality orders and nonconformances that involve the item or raw

material. To view a summary of quality orders and nonconformances, click Quality ordersQuality orders  or NonNon

conformancesconformances  on the Action Pane. Note:Note: Destructive quality orders can appear more than one time in the

trace details. When a destructive quality order is created for a document, such as a purchase order, it appears for

each transaction for that document.

You can generate the Shipped to customersShipped to customers  report to identify the amount of the item or raw material that has

been shipped and the customers that it was shipped to. For an inquiry that is related to compliance, you can

generate the report for all customers. For an inquiry that is related to customer service, you can generate the

report for a selected customer. If the product was a raw material that was used in the production of a finished

item, the finished item is also included. Note:Note: If you’re using the features for deleting or archiving sales orders,

the report results also include any sales orders that have been deleted or archived.

You can trace co-products, but you can’t trace a by-product, because tracking dimensions aren't typically

assigned to by-products. When you trace an item, the trace details include any related co-products. A node that

contains a co-product includes the word “co-product” in the details. You can also view details about a co-product

by selecting the node in the trace details and then clicking the ProductionProduction FastTab.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Trace an item or raw material
2/18/2021 • 2 minutes to read • Edit Online

Trace an item backwards using a known batch number

Identify an item, trace it forward, and make an analysis

This procedure demonstrates how to use item tracing to identify where items or raw materials have been used

or are being used. With this procedure, you can identify an item, trace it back to the source, and then trace

forward through the production and sale of the finished product. The process can be used to investigate the

customers impacted, the sales orders affected, and more. This procedure uses demo data company USP2.

1. In the Navigation paneNavigation pane, go to Modules > Inventor y management > Inquir ies and repor ts >Modules > Inventor y management > Inquir ies and repor ts >

Tracking dimensions > Item tracingTracking dimensions > Item tracing.

2. In the Item numberItem number  field, select 'P9100'.

3. In the list, click the link in the selected row.

4. In the For ward or backwardFor ward or backward field, select 'Backward'.

5. In the Batch numberBatch number  field, select 'as-12-344-01'.

6. In the list, click the link in the selected row.

7. Click OKOK.

The top node of the tree represents the on hand quantity of the selected item and batch. You need to expand the

nodes of the tree to find the item that the forward trace should be executed on.

1. In the tree, expand 'the nodes described below, and then select the last node'.

Expand: 'P9100 / 1 / 10 / as-12-344-01 ● 2 keg ● 7.00 gal \P9100 ● Picked ● Sales order 000072 ●

12/22/2015 ● -1 keg ● -4.00 gal ● Site=1, Warehouse=10, Batch number=as-12-344-01 \P9100 ●

Production B-000050 ● 12/9/2015● 7 keg ● 27.00 gal ● Site=1,Warehouse=10,Batch number=as-12-

344-01 ● Co-products: P9101' and then select that node.

2. In the tree, expand 'the node described below and then select that node'.

Starting from the node that you've just selected, expand 'M9103 ● Production line B-000050 ●

12/9/2015 ● -160.00 lb ● Size=70, Color=OK, Site=1, Warehouse=10, Batch number=App01' and then

select that node.

3. Click Trace from nodeTrace from node.

4. Click For wardFor ward.

5. On the Action PaneAction Pane, click TracingTracing.

There are several tracing options which provide information about the customers impacted by the item

that you're tracing, and the sales orders related to the item which have and haven't been shipped.

6. Click CustomersCustomers .

7. Close the page.

8. On the Action PaneAction Pane, click TracingTracing.

9. Click Shipped sales ordersShipped sales orders .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/tasks/trace-item-or-raw-material.md
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10. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Merge inventory batches
2/18/2021 • 8 minutes to read • Edit Online

Are there any prerequisites?
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Journal names, inventory You must create a journal name of the type BOM that is
used by default when you post batch merges in inventory
journals. Optional but recommended: You can specify that
reservations should be made automatically when the batch
merge is transferred to the inventory journal. Otherwise,
there is a risk that the on-hand inventory might be changed
after the batch merge details are set up and the journal is
posted. To enable automatic reservations for the journal
name, select AutomaticAutomatic in the Reser vationReser vation field.

Inventory and warehouse management parameters You must specify the default journal name for the inventory
journal.

This article provides information about how to consolidate two or more inventory batches into a merged batch.

When you merge batches, calculations can help optimize the characteristics and batch attributes of the merged

batch. After you select the source batches, you can review and change the merged batch before you post it. You

can also transfer the batch merge to an inventory journal for approval. Inventory can then be reserved or

posted directly from that inventory journal. When you post a merged batch, the inventory is adjusted for the

source batches and the merged batch.

Yes, there are some things that you must set up before you can use the merge batch tools. The following table

describes the prerequisites.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/merge-inventory-batches.md


Released products Here are the recommended settings for the item:

Batch number group Optional: To generate a batch number when you create a
merged batch, you must assign a batch number group to
the released product. Otherwise, you can enter a batch
number manually.
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When might I want to merge batches of inventory?

Can I merge batches across sites and legal entities?

Can I merge partial quantities?

What if the batches have different batch attribute values?

To automatically generate batch numbers for merged
batches, you must assign the released product to a
batch number group. You can also enter a batch
number manually when you create a merged batch,
or select an existing batch number. If you select an
existing batch number, make sure that the selected
batch hasn't been included in any inventory
transactions.

If you're using shelf life or best-before dates for the
released product, the dates for a merged batch are
calculated based on the selection in the BatchBatch
merge date calculationmerge date calculation field. The following options
are available:

EarliestEarliest  – The calculation is based on the
earliest date that is specified for a source
batch that is selected for the batch merge.

LatestLatest  – The calculation is based on the latest
date that is specified for a source batch that is
selected for the batch merge.

ManualManual – No calculation is done. If a date is
the same on all source batches, a date is
suggested. You can change that date. If a date
isn't the same on the source batches, you can
manually enter the date.

Here are some examples of scenarios where it might be useful to merge batches:

As Sammy is walking through his warehouse, he notices that several batches of the same item have low

quantities. He is expecting to receive several new shipments, and he realizes that he can free some floor

space by merging the odd quantities into a new batch.

Sammy is receiving inventory, and he wants to combine the new batch with one that he has already received,

to improve the batch attribute value of the existing batch. By doing so you create a new batch.

No, you can merge only batches that have the same site and warehouse storage dimensions in one legal entity.

However, you can specify a different location and pallet ID for the merged batch.

No, you can merge only the full quantity of batches. The batch merge functionality is intended as an inventory

feature, not a production feature.

When you select the source batches to combine in the merged batch, Supply Chain Management verifies

whether all the batches have the characteristics or attribute values. When an attribute value is the same, a value
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Grade 3 3 30

B ATC HB ATC H Q UA N T IT YQ UA N T IT Y AT T RIB UT EAT T RIB UT E AT T RIB UT E VA L UEAT T RIB UT E VA L UE

B1 10 Grade Blank

B2 15 Grade 15

B3 20 Grade 20

B4 25 Grade Blank

B5 30 Grade 25

B ATC HB ATC H Q UA N T IT YQ UA N T IT Y AT T RIB UT EAT T RIB UT E AT T RIB UT E VA L UEAT T RIB UT E VA L UE

B6 100 Grade 21

VA L UEVA L UE Q UA N T IT Y  ( W EIGH T )Q UA N T IT Y  ( W EIGH T ) REL AT IVE  W EIGH TREL AT IVE  W EIGH T REL AT IVE  W EIGH T  × VA L UEREL AT IVE  W EIGH T  × VA L UE

15 15 0.230769231 3.461538462

20 20 0.307692308 6.153846154

25 30 0.461538462 11.53846154

Total:Total:  65, which is the sum
of the weights

Total:Total:  21.5384615, which is
rounded to 21 (the nearest
increment)

What if the batches have different batch dates?

is suggested for the merged batch. You can change that value. Attribute values that aren't the same are left blank

for the merged batch, and you can enter those values manually. If the batch attribute type for the attribute value

is an integer or a fraction, and the values aren't the same for all the source batches, the value is calculated by

using a weighted average calculation. The calculated value is rounded up or down to the nearest increment. If

the value is blank for a source batch, the batch and its quantity aren't included in the calculation. ExampleExample The

following example shows a weighted average calculation for a merged batch. Two of the source batches have a

blank value for a batch attribute type that is an integer. The following attribute is assigned to the source batches.

The source batches have the following attribute values for the Grade batchGrade batch attribute.

When you add these batches as source batches, the following values are assigned to the merged batch.

The values and quantities for batches B1 and B4 aren't included in the weighted average calculation. Therefore,

here is how the value for the merged batch is calculated.

If the batches have different batch dates, some of the dates are calculated based on the values in the BatchBatch

datesdates  group on the Merged batchMerged batch FastTab of the Batch mergeBatch merge page. The system calculates values for the

fields in the Batch datesBatch dates  group. These values include the manufacturing date, expiration date, shelf advice date,

and best-before date. The dates are calculated based on settings for the item in the Item dataItem data field group of the



What if the dimensions are different on the batches that I want to
merge?

How does posting work?

After I merged a catchweight item, why can’t I see the catchweight
information in the inventory journal?

NOTENOTE

Released product detailsReleased product details  page. You can change the values or enter them manually. For all other dates, no

calculation is done. The same principle is used for batch attribute values. If a date is the same for all the source

batches, that date is suggested for the merged batch. If the date isn't the same for all source batches, the date is

blank on the merged batch, and you can enter it manually.

Here is how product dimensions, tracking dimensions, and storage dimensions are handled:

Product dimensionsProduct dimensions  – All product dimensions for the selected item must be the same. You can't merge

batches across product dimensions.

Tracking dimensionsTracking dimensions  – A new batch number is automatically generated if a batch number group is

specified for the item. If a batch number group isn't assigned to an item, you can select an existing batch or

enter the number manually. Serial numbers are transferred from the source batch to the inventory journal

lines for the merged batch.

Storage dimensionsStorage dimensions  – The site and warehouse storage dimensions must be the same for all the source

batches and the merged batch. However, you can specify a new location and pallet ID for the merged batch.

Posting works in two ways, depending on whether you use an approval process for journals. You can use the

Transfer to journalTransfer to journal  and Post the batch mergePost the batch merge actions to transfer the batch merge to a journal where it can

be verified and posted, or you can post the batch merge directly. The main difference between the two actions is

that a transfer to a journal doesn't post the batch merge. Both actions create a new batch if an existing batch isn't

selected, update all batch details and attribute values, and create an inventory journal.

Transfer to journalTransfer to journal  – Transfer the batch merge details to a new inventory journal. If you've set up automatic

reservations, the quantities in the source batches are reserved. The details of the batch merge can't be

changed. To modify the batch merge, you must delete the journal. The journal can be used as a task that

another employee must perform later. The reservation of the batch quantity to the journal line is secured.

This allocation lets a quality planner or a warehouse manager create tasks for his or her employees.

Post the batch mergePost the batch merge – Post the batch merge directly. This action can be performed after the physical

merge has occurred.

You can approve the inventory journal for the batch merge from the All batch mergesAll batch merges  list page. Click JournalJournal

> PostPost. After a journal is posted, you can't change the details in the merged batch. After you transfer a batch

merge to an inventory journal, you can change the details only if the journal is deleted.

You can merge batches of catch-weight items just like all other items. However, the catch-weight information

doesn't appear in the inventory journal. We recommend that you verify the catch-weight information before you

transfer the batch merge to the inventory journal.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Correct inventory tracking information
2/18/2021 • 2 minutes to read • Edit Online

Create an inventory transfer journal

Create journal lines

Post the journal

Check tracing information

Check inventory transactions

This procedure walks you through the process of creating and posting an inventory transfer journal in order to

correct inventory tracking information. In this example, we'll update the information of a batch controlled item

by changing an incorrectly registered batch to another batch. You can walk through this procedure in demo data

company USPI, or using your own data. If you use your own data, you need to have an item that's batch-

enabled, and it must not be location-controlled. You also need to have an inventory journal name set up for

inventory transfers. These tasks would normally be carried out by a warehouse employee.

1. Go to Transfer.

2. Click New.

3. In the Name field, enter or select a value.

4. Click OK.

1. Click New.

2. In the Item number field, enter or select a value.

3. In the Quantity field, enter a number.

4. Click the Inventory dimensions tab.

5. In the Batch number field, enter or select a value.

6. In the Site field, enter or select a value.

7. In the Warehouse field, enter or select a value.

8. In the Batch number field, enter or select a value.

If you are using USPI, select item M5003.

1. Click Post.

2. Click OK.

1. Click Inventory.

2. Click Trace.

3. Click OK.

4. Close the page.

Using this tracing information you can back trace which batch you corrected inventory from. You can

also use the Item tracing page to see this information.

1. Click Inventory.

2. Click Transactions.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/tasks/correct-inventory-tracking-information.md


NOTENOTE

Here you can see the transactions that were created when you posted your journal.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Working with serialized items
2/18/2021 • 6 minutes to read • Edit Online

When do I register serial numbers during the sales process?

Can I enter serial numbers by scanning them, or do I have to type
them?

If I enable serial numbers for the sales process, do I have to register
all serial numbers for all items?

This topic explains how you can register serial numbers on packing slips or invoices during the sales process.

This functionality is useful if a company wants to capture serial numbers for service and warranty purposes, but

doesn't have to maintain serial numbers in inventory from receipt to issue.

Many companies just want to capture serial numbers for service and warranty purposes, and don't have to

maintain serial numbers in inventory from receipt to issue. In these scenarios, you can register the serial

numbers on the packing slips or invoices when products are sold. If products are later returned, you can trace

each product to an invoice to determine whether you sold the product, and whether the service or warranty

obligations are valid.

You must enable serial numbers for the sales process by selecting the Active in sales processActive in sales process  option on the

Tracking dimension groupsTracking dimension groups  page. The following events then occur in Supply Chain Management:

On the Ser ial numbersSerial numbers  FastTab, the Ser ial number controlSer ial number control  option is selected. When this option is

selected, you must register one serial number for each item on the packing slip or invoice.

All selections on the tracking dimension group for serial numbers are cleared, except the Blank issueBlank issue

allowedallowed option. You can select the Blank issue allowedBlank issue allowed option to override the serial number control, and

allow products to be packed and invoiced without registering serial numbers.

You can register serial numbers either on the packing slip for a sales order or on the invoice. When you prepare

an invoice for a serialized item that was shipped together with a packing slip, you can select which serial

numbers on the packing slip to invoice. The number of registered serial numbers must not exceed the quantity

of items that were shipped. If you're creating a partial invoice, you can select fewer serialized items than were

registered on the packing slip. When you print a packing slip or an invoice, the serial numbers that were

registered are included.

You can either scan or type serial numbers. When you use a scanner, the scan mode determines whether the

serial numbers are added to or removed from the list of serial numbers on the invoice or packing slip. If you

want to scan serial numbers  by using, for example, a hand-held bar code scanner, configure the scanner to send

an Enter or TAB command after the serial number. This command will indicate the end of the data stream.

Otherwise, you must press Enter or TAB on the keyboard after you scan each serial number.

The setup of the tracking dimension group that is assigned to the product determines whether serial numbers

must be registered for all items on a packing slip or invoice. When you enable serial numbers for the sales

process, the Ser ial number controlSer ial number control  option is automatically selected. You must then register one serial number,

or register a blank registration for an unreadable number, for each item on the packing slip or invoice. If you

don't want to require a serial number for each item, select the Blank issue allowedBlank issue allowed option on the tracking

dimension group that is assigned to the item. You can then register fewer serial numbers than the quantity of

items that are being shipped. If you register more serial numbers than the quantity of items that are being

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/register-serial-numbers-sales-process.md


Can I register serial numbers for partial invoices and partial
shipments?

What do I do when a serial number isn't readable?

Can I correct or change the serial numbers that I have registered for a
sales order?

Can I view the serial numbers that were shipped together with a
specific packing slip, or that were included on an invoice?

Can I view the serialized items that I have on hand?

Can I register serial numbers for catchweight items?

Can I register serial numbers at the retail POS?

shipped, you won't be able to post the packing slip or invoice.

You can create partial invoices and packing slips for sales orders, and register only the serial numbers for the

items that those invoices and packing slips include. If you want to create a partial invoice, and you have more

than one packing slip for the sales order, you can include serial numbers from more than one packing slip.

However, there can be only one packing slip that doesn't include all serial numbers. For example, if you have

three packing slips, and each packing slip includes two serialized items, you can't create a partial invoice for one

item from each packing slip.

If a serial number can't be read or scanned, you can create a blank line for the item by clicking Not readableNot readable on

the Ser ial numbersSerial numbers  page. If the serial number becomes available later, you can update the invoice or packing

slip. For more information, see the next section, “Can I correct or change the serial numbers I have registered for

a sales order?”

Yes, you can correct serial numbers if the following conditions are met:

InvoicesInvoices  – You can change the serial numbers for items that you haven't yet invoiced. The packing slip is

then also updated. However, if a sales order line was corrected by registering a negative quantity, you can't

change serial numbers for the sales order line.

Packing slipsPacking slips  – You can't partially correct a packing slip line that contains serialized items. You must reverse

the full quantity for the line. If a packing slip has been canceled or corrected, you don't have to register the

reversed serial numbers again when you create a new packing slip for the same serialized items. The

numbers that were registered will be used.

Yes, you can run an inquiry on the packing slip journal line or invoice journal line to view a list of all serial

numbers that were included in the document.

No, you can't view the serialized items that you have on hand, because serial numbers aren't registered for items

until the items are sold.

No, you can't register serial numbers for catch-weight items during the sales process. Additionally, if a product is

set up as a catch-weight item, you can't assign the product to a tracking dimension group that is set up to use

serial numbers only during the sales process.

Yes, the retail point of sale (POS) will prompt the user to enter a serial number when the user sells an item that is

assigned a tracking dimension group that is set up to use serial numbers only during the sales process.



What security roles are required in order to register serial numbers
during the sales process?

NOTENOTE

This functionality is available to all roles that can maintain sales packing slips and sales invoices. The following

duties let workers correct serial numbers, and register blank entries for serial numbers that can't be read or

scanned:

Maintain serial number corrections

Maintain registration of non-readable serial numbers

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Inventory on-hand mobile workspace
2/18/2021 • 3 minutes to read • Edit Online

Overview

Prerequisites

Prerequisites if you use Supply Chain ManagementPrerequisites if you use Supply Chain Management

Prerequisites if you use Platform update 3 or laterPrerequisites if you use Platform update 3 or later

This topic provides information about the Inventor y on-handInventor y on-hand mobile workspace. This workspace helps you

gain insights into reserved and available inventory anytime and anywhere.

This mobile workspace is intended to be used with the Finance and Operations mobile app.

Typically, companies have multiple shipments and multiple receipts of inventory every day. These movements

constantly change the on-hand inventory status. The Inventor y on-handInventor y on-hand mobile workspace lets you see the

cross-company on-hand inventory status, so that you can gain the latest insights into inventory data on the

mobile device of your choice. Regardless of whether you work in the warehouse, purchasing, sales,

manufacturing, or management, or have other roles, you can access on-hand inventory data anytime and

anywhere.

The mobile workspace provides an instant view of the on-hand status across facilities. It lets you view on-hand

inventory across facilities, current material reservations, and unreserved on-hand inventory. You can also enter

item numbers to query on-hand inventory, and can do a filtered search for on-hand products or variants.

Specifically, the mobile workspace provides these features:

You can search by product number or product name to find products to view the on-hand inventory

status for.

For the selected products, you can view the following information:

On-hand inventory per site

On-hand inventory per warehouse

On-hand inventory per location

On-hand inventory per batch (for batch-controlled products)

On-hand inventory per inventory status

Product on-hand inventory is shown in the following ways:

By physical inventory (This view represents the total amount.)

By physical reserved (This view represents the reserved amount.)

By available physical (This view represents available amount that has no reservations.)

The prerequisites differ, based on the version of Supply Chain Management that has been deployed for your

organization.

If Supply Chain Management has been deployed for your organization, the system administrator must publish

the Inventor y on-handInventor y on-hand mobile workspace. For instructions, see Publish a mobile workspace.

If Platform update 3 or later has been deployed for your organization, the system administrator must complete

the following prerequisites.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/inventory-on-hand-mobile-workspace.md
file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/publish-mobile-workspace.html
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Implement KB 4013633. System administrator KB 4013633 is an X++ update or
metadata hotfix that contains the
Inventor y on-handInventor y on-hand mobile
workspace. To implement KB 4013633,
your system administrator must follow
these steps.

Publish the Inventor y on-handInventor y on-hand
mobile workspace.

System administrator See Publish a mobile workspace.

Download and install the mobile app

Sign in to the mobile app

View the on-hand inventory for a product by using the Inventory on-
hand mobile workspace

1. Download the metadata hotfix
from Microsoft Dynamics
Lifecycle Services (LCS).

2. Install the metadata hotfix.

3. Create a deployable package
that contains the SCMMobileSCMMobile
model, and then upload the
deployable package to LCS.

4. Apply the deployable package.

Download and install the Finance and Operations mobile app:

For Android phones

For iPhones

1. Start the app on your mobile device.

2. Enter your Dynamics 365 URL.

3. The first time that you sign in, you're prompted for your user name and password. Enter your credentials.

4. After you sign in, the available workspaces for your company are shown. Note that if your system

administrator publishes a new workspace later, you will have to refresh the list of mobile workspaces.

file:///T:/eiye/ac1a/dynamics365/dev-itpro/migration-upgrade/download-hotfix-lcs.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/migration-upgrade/install-metadata-hotfix-package.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/create-apply-deployable-package.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/apply-deployable-package-system.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/publish-mobile-workspace.html
https://go.microsoft.com/fwlink/?linkid=850662
https://go.microsoft.com/fwlink/?linkid=850663
file:///T:/eiye/ac1a/dynamics365/supply-chain/inventory/media/pull-to-refresh-list-of-workspaces.png


NOTENOTE

1. On your mobile device, select the Inventor y on-handInventor y on-hand workspace.

2. Select Check on-hand for an itemCheck on-hand for an item. You see a list of the products that are loaded into your app for

offline use. By default, 50 items are loaded, but a developer can change this number. For more

information, developers should see Mobile platform.

3. If your item isn't in the list, select Search moreSearch more. Search by product number, or switch to a search by

product name.

4. Select a product. If the item has an image, the image is shown.

5. Select one of the following options to view the status of on-hand inventory:

View on-hand per site

View on-hand per warehouse

View on-hand per location

View on-hand per batch (for batch-controlled products)

View on-hand per inventory status

Product on-hand inventory is shown in the following ways:

By physical inventory (This view represents the total amount.)

By physical reserved (This view represents the reserved amount.)

By available physical (This view represents the available amount that has no reservations.)

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/platform/mobile-platform-home-page.html
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Troubleshoot inventory operations
2/18/2021 • 7 minutes to read • Edit Online

I can't find the "Workflow" drop-down dialog box for inventory
journals.
Issue descriptionIssue description

Issue resolution 1Issue resolution 1

Issue resolution 2Issue resolution 2

[ExtensionOf(formStr(InventJournalMovement))]
public final class InventJournalMovement_extension
{
    public boolean canSubmitToWorkflow()
    {
        boolean ret = YourLogicOfCanSubmitToWorkflow();

        return ret;
    }
}

Issue resolution 3Issue resolution 3

My inventory journal remains in system-locked status, and the

This topic describes how to fix issues that you might encounter while you work with inventory operations.

You can't find the WorkflowWorkflow  drop-down dialog box on the journal page, or related workflow operations aren't

available.

This issue can occur for three reasons, as described in the following subsections.

If the issue applies to all users, it might be occurring because the approval workflow hasn't been assigned to the

journal name. To fix the issue, follow these steps.

1. Go to Inventor y Management > Setup > Journal names > Inventor yInventor y Management > Setup > Journal names > Inventor y .

2. In the list pane, select a journal name to open its settings.

3. On the GeneralGeneral  FastTab, set the Approval workflowApproval workflow  option to Yes. If you're prompted to confirm the

change, select YesYes .

4. In the WorkflowWorkflow  field, select the workflow that you want to use for the selected journal name.

If your workflow uses customized code, issues might occur after you upgrade the system. For example, in the

journal workflow, the SubmitSubmit button might be grayed out so you can't select it to approve a submission.

If the SubmitSubmit button is grayed out, your workflow might have been customized, which means the method of

the workflow, canSubmitToWorkflow()  in FormDataUtil , has been extended. To fix this issue, change the way that

you extend the method of the canSubmitToWorkflow()  to use the structure in the following example.

If the issue applies only to a few specific users, those users might not have the security privileges that are

required to run workflow operations on inventory journals. Verify that each affected user has the Maintain

inventory journal workflow security privilege. By default, this privilege is assigned to a duty that has same name,

and that duty is applied to the Warehouse worker and Warehouse manager roles.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/troubleshoot-inventory-operations.md


workflow batch job doesn't work.
Issue descriptionIssue description

Issue resolutionIssue resolution

My inventory journal workflow is never completed, and the journal
can't be edited or posted.
Issue descriptionIssue description

Issue resolutionIssue resolution

Inventory journal workflow conditions apply only at the journal level,
not at the line level
Issue descriptionIssue description

Issue workaroundIssue workaround

The filter pane on the On-hand list page doesn't filter results as I
expect.
Issue descriptionIssue description

Issue resolutionIssue resolution

One of your inventory journals is locked by some operation and isn't being released. For example, if an

unknown error occurs during posting (which is a system lock operation), the journal might remain in system-

locked status. In this case, the workflow work item handler will throw an error while it does lock validation.

Sign in to the SQL Server instance for Supply Chain Management, and check whether

InventJournalTable.SystemBlockedInventJournalTable.SystemBlocked is set to 1. If it is, make sure that the journal should not be in locked

status, and then reset InventJournalTable.SystemBlockedInventJournalTable.SystemBlocked to 0.

After you submit a journal approval workflow, workflow processing stops responding, and you can't edit or

process your journals.

There are several reasons why workflow processing might not be completed. Check for the following issues:

Go to Inventor y management > Setup > Inventor y management workflowsInventor y management > Setup > Inventor y management workflows , and review the

configuration of the affected workflow. For more information, see Inventory journal approval workflows.

The workflow might be encountering an exception or error. Review the work item history of the affected

workflow to see whether it includes an application error that terminates the workflow.

The inventory journal can be updated or edited only if it's approved. If recall is active, you can try to recall the

journal. Execution of the workflow batch job might be suspended for multiple reasons. Some of these

reasons might be caused by the workflow framework issue.

You might experience this issue if, for example, you try to set up an inventory journal workflow condition on the

cost amount. You set up the condition so that step 1 is run only when the cost amount is less than 100. You then

set up another condition so that step 2 is run only when the cost amount is more than or equal to 100. Then,

when the workflow is run, the workflow history shows only one line, and the first condition is always evaluated

as true, regardless of the value that is submitted.

In the current release, inventory workflow conditions apply only at the journal level, not at the line level. This

behavior is by design. We recommend that you set your condition criteria only on journal-level attributes.

The filters in the filter pane on the On-hand listOn-hand listpage don't filter results as you expect.

This behavior is by design.



The unit and unit quantity aren't working correctly in the inventory
journal.
Issue descriptionIssue description

Issue resolutionIssue resolution

I receive the following error message: "Maximum number of decimals
for the stock keeping unit is 0."
Issue descriptionIssue description

Issue resolutionIssue resolution

TheOn-hand listOn-hand listpage is assembled from a detailed on-hand inventory table that includes all available

dimensions. However, the list on this page is a summary. Therefore, it might combine rows from the source table

by aggregating values according to the dimensions that are shown.

Filters that are set up in thefilterpane apply to the source table, not to the aggregated list. This behavior can

sometimes produce unexpected results, as shown in these examples.

However, thefilters that are provided in the griddoapply to the aggregated list. These filters include both the

QuickFilter at the top of the grid and the filter for each column heading.

You might encounter one or both of the following issues when you work with units and quantities in an

inventory journal:

You don't see units or unit quantities in the inventory journal while a unit of conversion is set up for the

released product, and you can't change the unit in the inventory journal.

You see the QuantityQuantity  and UnitUnit fields in the inventory journal, but you don't see the Unit quantityUnit quantity  field. If

you change the unit, enter a quantity, and post the journal, the journal still shows the original unit of

measurement for that quantity.

To fix this issue, follow these steps.

1. In the Feature managementFeature management workspace, make sure that the Using unit of measure and unit quantity in

inventory journals feature is turned on. This feature adds the UnitUnit and Unit quantityUnit quantity  fields to the

journal.

2. After the feature is turned on, use the QuantityQuantity , Unit quantityUnit quantity , and UnitUnit fields in the following way:

QuantityQuantity  – Specify the quantity by using the default unit that is defined for the released product.

However, the default unit itself isn't shown here. If a conversion is set up between the default unit and

the unit that is selected in the UnitUnit field, the QuantityQuantity  field is automatically updated, based on the

selections in the Unit quantityUnit quantity  and UnitUnit fields.

Unit quantityUnit quantity  – Specify the quantity by using the unit that is selected in the UnitUnit field.

UnitUnit – Select the unit to apply to the value in the Unit quantityUnit quantity  field.

When you try to post an inventory transaction or an inventory reservation, you receive the following error

message: "Maximum number of decimals for the stock keeping unit is 0."

This issue occurs when the inventory transaction quantity is specified as a decimal value that is below the level

of precision that the field supports. For example, a quantity of 0.5 has been specified for an inventory

transaction, but only integer quantities are supported. Therefore, the value should be 1 instead of 0.5.

1. Run the following script on your SQL Server instance to round quantities in the inventory transactions.

This script will correct values in the inventTransinventTrans  table.



IMPORTANTIMPORTANT

NOTENOTE

update it set it.QTY = round(it.qty, decimalPrecisionValue) from inventtrans it where 
it.DATAAREAID='XXXX' and it.PARTITION=XXXXXX and it.qty <> round(it.qty, decimalPrecisionValue) and 
exists (select 'x' from INVENTTABLEMODULE a, unitofmeasure b where  a.unitid =b.SYMBOL and 
a.partition=it.partition and a.PARTITION=b.PARTITION and  MODULETYPE =0 and  
b.DECIMALPRECISION=decimalPrecisionValue and a.DATAAREAID='XXXX' and a.ITEMID =it.ITEMID and 
it.DATAAREAID=a.DATAAREAID)

2. Run an on-hand consistency check where the fix errorfix error  option is turned on. This check will correct values

in the inventSuminventSum table.

We strongly recommend that you carefully edit the script as required for your environment, test it in a test environment,

and then check the resulting data before you run the script in a production environment.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Outbound process overview
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Output orders

Picking route status for sales and transfer orders

This topic provides an overview of the outbound process in Inventory management.

Output orders are used to link sales order lines and transfer order lines with the outbound picking processes

that use picking lists.

When picking lists are generated from either sales orders or transfer orders, output orders and shipments are

automatically created. A picking list has a one-to-one relationship with a shipment. The transfer order shipment

or the sales order packing slip can be processed from the shipment.

The following diagram shows an overview of the process for outbound orders.

You can set up outbound rules to define how the program should handle the outbound process. You can use

these rules to control the shipment process. In particular, you can use the rules to control which stage in the

process a shipment can be sent during. The following settings define how the outbound processes are handled.

Go to Account receivableAccount receivable > SetupSetup > Account receivable parametersAccount receivable parameters , and then, on the UpdatesUpdates  tab, select

a value in the Picking route statusPicking route status  field.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/outbound-process.md
file:///T:/eiye/ac1a/dynamics365/supply-chain/inventory/media/outbound-order.png


End output inventory orders

If the Picking route statusPicking route status  field is set to CompletedCompleted, the picking process occurs automatically as part of the

process of generating picking lists. If the field is set to ActivatedActivated, the picking list lines must be manually

updated.

The same setup applies to transfer orders. Go to Inventor y managementInventor y management > SetupSetup > Inventor y andInventor y and

warehouse management parameterswarehouse management parameters , and then, on the Transpor tTranspor t tab, select a value in the Picking routePicking route

statusstatus  field.

Go to Inventor y managementInventor y management > SetupSetup > Inventor y and warehouse management parametersInventor y and warehouse management parameters , and

then, on the GeneralGeneral  tab, set the End output inventor y orderEnd output inventor y order  option.

file:///T:/eiye/ac1a/dynamics365/supply-chain/inventory/media/picking-route-status-sales-order.png
file:///T:/eiye/ac1a/dynamics365/supply-chain/inventory/media/picking-route-status-transfer-order.png
file:///T:/eiye/ac1a/dynamics365/supply-chain/inventory/media/end-output-inventory-order.png


Reduce quantity

Example of an outbound process for a sales order

When the warehouse worker reduces the picking list quantities, then the corresponding inventory order

quantities will be removed from the shipment. When the picking list is updated at a point in time, the remaining

quantities get reported back to the order if the End output inventor y orderEnd output inventor y order  option is set to YesYes . If the EndEnd

output inventor y orderoutput inventor y order  option is set to NoNo, the remaining quantities are kept as an open output order

quantity and must be added to a new picking list as part of the Open output ordersOpen output orders  functionality.

The third parameter that you can use as part of the process of generating picking lists is the Reduce quantityReduce quantity

parameter. The setting of this parameter works together with the Reser vationReser vation setting that triggers a

reservation process as part of the release to the warehouse.

For this example, there is a sales order for two items. During picking list generation, you select the ReduceReduce

quantityquantity  parameter. Therefore, you release and create picking lines only for available on-hand inventory. The

picking must be reported via a registration process for picking lists (Picking route statusPicking route status  = ActivatedActivated).

file:///T:/eiye/ac1a/dynamics365/supply-chain/inventory/media/open-output-order.png
file:///T:/eiye/ac1a/dynamics365/supply-chain/inventory/media/open-output-order-function.png
file:///T:/eiye/ac1a/dynamics365/supply-chain/inventory/media/reduce-quantity.png


NOTENOTE

The inventory that hasn't already been reserved is reserved during picking list generation. The unavailable

inventory can be either removed from the sales order or released to the warehouse for outbound processing

later, when inventory is available for picking.

As soon as all the picking lines have been picked on the Picking list registrationPicking list registration page, the associated

shipment is completed. The process for sales order packing slips can then be initialized based on the picked

inventory.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Reserve inventory quantities
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Inventory reservation policies

Policies on the Item model groups pagePolicies on the Item model groups page

Reser vation policyReser vation policy DescriptionDescription

FIFO date-controlled If you select the FIFO date-controlledFIFO date-controlled option, the
inventory reservation is controlled by a sorting date
according to the FIFO principle. Batches are reserved based
on the earliest date of receipt of items, according to the
principle of first in, first out (FIFO).

This topic describes the different options that are available for reserving inventory.

You can automatically reserve inventory quantities for a specific sales order. This means that reserved inventory

cannot be withdrawn from the warehouse for other orders unless the inventory reservation, or part of the

inventory reservation, is canceled.

There are several reasons for reserving inventory:

First ordered, first delivered, which means that customers get available items in the same order in which they

place their orders.

Shortage of items due to a long or unknown delivery time from the vendor. You might want to make sure

that certain customers or orders get delivery of the first-available items.

Certain customers and certain types of orders have first priority for delivery.

Items with serial or batch numbers. You can mark certain items that have been or will be delivered to specific

orders.

Specially ordered items that are reserved for certain orders.

Production orders. For example, you can mark items that are produced for and adjusted to specific orders.

Inventory can be reserved automatically when a new order line is created, or inventory can be reserved

manually on the individual orders. It's also possible to reserve inventory at different stages in a production

process. Only stocked products can be reserved. Services cannot be reserved, because there is no on-hand

inventory. Both physical on-hand inventory and ordered, but not yet received, inventory can be reserved. If a

larger quantity is reserved than what the on-hand inventory contains, a message displays that you cannot

reserve such a large quantity. You can then either reserve the quantity anyway, or change the ordered quantity.

The quantity can be either reserved or changed. If more items are reserved than are available, the shortage is

covered the next time that items are available for delivery.

Inventory reservation policies are set on the Item model groupsItem model groups  page, the Inventor y and warehouseInventor y and warehouse

management parametersmanagement parameters  page, and the Production parametersProduction parameters  page.

The Inventor y policiesInventor y policies  section contains the following reservation policies.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/reserve-inventory-quantities.md


Backward from ship date This option becomes available if you have selected the FIFOFIFO
date-controlleddate-controlled option. If you select Backward fromBackward from
ship dateship date, the inventory is reserved backward from the
desired ship date according to the principle of last in, first
out (LIFO). If no receipts are available before the ship date, a
FIFO reservation is used.

Item sales reservation Determines whether item reservation is manual or
automatic. If a reservation is automatic, inventory is
reserved when order lines are created. It’s possible to make
reservations at the item number level for BOMs (AutomaticAutomatic
option), or for the individual elements of a BOM (ExplosionExplosion
option). The default value for Item sales reser vationItem sales reser vation may
be inherited from Accounts receivable parameters.Accounts receivable parameters.  On
that page, the value is set in the Reservation field in the
Sales default valuesSales default values sectionsection on the GeneralGeneral tab.

Same batch selection Same batch reservation lets you reserve inventory for a
sales order line against a single batch of inventory. If you
want to use this option, you must also set the ConsolidateConsolidate
requirementrequirement  option to YesYes . There are additional settings
that are required for the tracking dimension group and
storage dimension group. For more information, see Reserve
the same batch for a sales order.

Consolidate requirement This option is similar to the Same batch selectionSame batch selection option,
and it consolidates inventory that’s reserved for sales order
lines into a single requirement.

FEFO date-controlled This option allows you to reserve batches that are close to
their expiration date or best before date. You also need to
set the Pick criteriaPick criteria field to select either Expiration dateExpiration date
or Best before dateBest before date.

Example for FIFO date-controlled and Backward from ship dateExample for FIFO date-controlled and Backward from ship date

IT EM  N UM B ERIT EM  N UM B ER B ATC H  N UM B ERB ATC H  N UM B ER Q UA N T IT YQ UA N T IT Y DAT EDAT E

A 1000 5 February 2, 2016

A 1001 3 January 1, 2016

A 1002 7 March 3, 2016

Policies on the Inventory and warehouse management parameter pagePolicies on the Inventory and warehouse management parameter page

In this example, on-hand inventory for item number A exists for three different batch numbers.

A sales order that should be automatically reserved and delivered on April 4, 2016, reserves the following batch:

If both the FIFO date-controlledFIFO date-controlled and Backward from ship dateBackward from ship date check boxes are cleared, batch 1000 is

reserved because it is the batch with the lowest number.

If the FIFO date-controlledFIFO date-controlled check box is selected and the Backward from ship dateBackward from ship date check box is cleared,

batch 1001 is reserved because it is the batch with the first date of receipt (FIFO).

If both the FIFO date-controlledFIFO date-controlled and Backward from ship dateBackward from ship date check boxes are selected, batch 1002 is

reserved because it is the batch receipt closest to the sales order ship date.

There are two options related to reservations on the Inventor y and warehouse management parametersInventor y and warehouse management parameters



Inventory reservation policies on the Production parameters pageInventory reservation policies on the Production parameters page

NOTENOTE

page:

The Reser ve ordered itemsReser ve ordered items option on the GeneralGeneral  tab lets you to reserve item receipts that are ordered

against item issues in Accounts receivable, Project management and accounting, and Production control. If

you clear this option, you can only reserve items that have been physically received. If a particular item has

been set up to accept negative inventory, this field is not relevant.

The Reser ve items automaticallyReser ve items automatically  option on the Transpor tTranspor t tab determines the default setting if items are

automatically reserved for transfer orders. The default setting can be overridden on individual transfer

orders.

The value of the Reser vationReser vation field on the GeneralGeneral  tab on the Production parametersProduction parameters  page determines the

default point in the production process at which inventory should be reserved. For example, inventory could be

reserved when work is scheduled, or when work is started.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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This article explains how to set up a product to allow reservation of inventory against a single batch of

inventory.

Same batch reservation lets you reserve inventory for a sales order line against a single batch of inventory. For

example, a customer who orders wallpaper can request that the whole order be filled from the same batch or

lot, to avoid inconsistencies among the rolls. To set up a product to use same batch reservation, the following

settings must be active in the item model group, tracking dimension group, and storage dimension group that

you assign to the product:

Item model groupsItem model groups  – The item model group must have the Same batch selectionSame batch selection and ConsolidateConsolidate

requirementrequirement fields selected in the Reser vationReser vation field group for inventory policies.

Tracking dimensions groupsTracking dimensions groups  – The tracking dimension group must have the Coverage plan byCoverage plan by

dimensiondimension field selected for the batch number.

Storage dimensions groupsStorage dimensions groups  – The storage dimension group must have the Coverage plan byCoverage plan by

dimensiondimension field selected for S iteSite and WarehouseWarehouse.

When you reserve inventory for a product on a sales order line that is set up for same batch selection, the

system tries to reserve the ordered quantity from a single inventory batch. Any specific batch attribute

requirements are also considered. If the quantity can't be filled from a single batch, the Same batchSame batch

reser vation conflictreser vation conflict page appears. This page describes the issues and also the actions that you can take to

continue with the reservation. The following conditions might prevent the batch from being reserved:

The batch disposition code has Block reser vationBlock reser vation for sales flagged as BlockedBlocked.

The batch has expired, based on the expiration date and any applicable customer sellable days. The item can

still be considered for reservation if the item model group for the item is First Expiry First Out (FEFO) date–

controlled, and if the best-before date is selected as the pick criterion.

The batch doesn't have enough shelf-life days remaining, based on the expiration date and best-before date,

plus any customer sellable days.

For items associated with a storage dimension group that has Use warehouse management processesUse warehouse management processes

enabled, you can reserve specific batch numbers by using a reservation hierarchy with the batch number

inventory dimension defined above the location dimension. The Batch reser vationBatch reser vation page for sales and transfer

order lines also lets you select and reserve multiple lines based on the available batch numbers. For more

information about what to do if you are using a reservation hierarchy that has the batch number dimension

below the location, see Flexible warehouse-level dimension reservation policy.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Inventory recalculation and the general ledger

Effects of the inventory close process on the general ledger

As part of the process to settle issue transactions with receipt transactions, you can also choose to have the

general ledger updated to reflect the adjustments that have been made.

The inventory close process settles issue transactions to receipt transactions, based on the inventory valuation

method that is selected in the item’s item model group. As part of the settlement process, you can specify that

the general ledger should be updated, so that it reflects the adjustments that have been made. However, until

inventory close or recalculation has been run, issue transactions are posted at the calculated running average

cost price.

After inventory close, you can no longer post in periods that are before the inventory closing date that you set,

unless you reverse a completed inventory close process. For example, if inventory close is run for the period

that ends on January 31, you can't post transactions that have a date that is earlier than January 31.

Items in inventory are assigned to one of two inventory types: item or service. Inventory close performs the

same functions for both types. However, for service items, inventory close still settles issues to receipts.

How often the inventory close process is run varies by company. However, transaction volume should help

determine how often you decide to run inventory close. In general, most companies run inventory close as part

of their month-end close and reconciliation procedures.

If adjustments to inventory and the general ledger are required during a month or other inventory period, you

can run inventory recalculation instead of inventory close. Inventory recalculation makes adjustments but

doesn't make settlements to inventory transactions.

During inventory recalculation, on-hand inventory is adjusted, inventory transactions are adjusted, and

inventory recalculations and inventory closes are run. These tasks affect any ledger account that is linked to the

original inventory transaction.

ExampleExample

When you create a purchase order from a sales order, the general ledger accounts that are used for the original

sales order are updated. Even if the ledger accounts for the item group that is assigned to the item were

changed after the sales order was posted, and an inventory recalculation created an adjustment amount, the

adjustment amount is posted to the original ledger accounts. The adjusted amount isn’t posted to the new

ledger accounts that are assigned to the item.

After the update is completed, you can review the ledger voucher that is posted because of one of these tasks.

1. On the Closing and adjustmentClosing and adjustment page, on the Over viewOver view  tab, select the update to review.

2. Click DetailsDetails , and then select VoucherVoucher .

Several of the tasks that you can perform on the Closing and adjustmentClosing and adjustment page cause an update to general

ledger. For example, the general ledger is updated when you make inventory on-hand adjustments, make

inventory transaction adjustments, run inventory recalculation, and run inventory close.

The ledger accounts that are updated because of these tasks are linked to the original inventory transaction. For

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/inventory-close.md
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The inventory close log

Reversing a completed inventory close

example, if a sales order is settled to a purchase order, the general ledger accounts that were used for the

original sales order are adjusted. This behavior occurs even if the ledger accounts for the item group that is

assigned to the item have changed since the sales order was posted. After inventory close creates a settlement

amount, the settlement amount is still posted to the original ledger accounts, not to the new ledger accounts

that are assigned to the item. The general ledger might also be updated if you reverse an inventory close.

Inventory close is a required step in the month-end closing procedure for all inventory models except moving average.

You will be warned if you try to close a financial period without first performing the inventory close as of the period

end date.

Before you run the closing procedure, you can view a list of items that can't be settled during the update.

We recommend that you run inventory close during off-peak hours, to distribute computing resources more evenly.

After the inventory close process has been completed, a message in the message center might inform you that a

unit cost price might be incorrect because a transaction could not be fully settled.

Before this message is shown, the system reports the item number and the affected transaction. The message

informs you that the cost amount that is used for this transaction wasn't updated because of the inventory close.

This message appears when a transaction of the issue type can't be settled.

During the inventory close process, the system checks each financial dimension to see whether there are more

issues than receipts up to the specified closing date. This type of imbalance can occur when an inventory

transaction from a purchase order isn't fully posted financially, either because the vendor invoice hasn't been

received, or because bill of materials (BOM) components that are included in a production on a higher level

aren't financially posted. (The sub-production isn't cost-calculated.) In this case, the subsequent close won't

adjust all issues to the correct cost price, because not enough receipt information is available.

For each run of the closing procedure, the system indicates whether a log that contains the warnings is stored

and can be viewed.

If you receive many warnings in the message, we recommend that you perform the following actions:

Update receipts financially.

Advance the closing date.

Reevaluate the business procedures.

In some circumstances, you might not be able to do anything about the warnings. For example, if marking is

used, and the marked purchase order has a financial date that is after the closing date, the closing date can't be

changed.

Occasionally, you might have to reverse a completed inventory close to return settlements to the state that they

had before adjustments were made. When you reverse a completed inventory close, inventory is reopened to

enable posting in the period that the inventory close covers. Related changes might also be made in the general

ledger. After you've finished making adjustments, you can run inventory close again for the period that you're

working with.
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Only the last inventory period that was closed can be reopened. To reverse an earlier inventory close, you must reverse

each subsequent inventory close one at a time, starting with the most recent close.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Using the running average cost price

C O N DIT IO NC O N DIT IO N
T H E SY ST EM  USES T H E EST IM AT EDT H E SY ST EM  USES T H E EST IM AT ED
RUN N IN G AVERA GE C O ST  P RIC ERUN N IN G AVERA GE C O ST  P RIC E

T H E SY ST EM  USES T H E C O ST  P RIC ET H E SY ST EM  USES T H E C O ST  P RIC E
T H AT  IS DEF IN ED O N  T H E IT EMT H AT  IS DEF IN ED O N  T H E IT EM
M A ST ERM A ST ER

Both the numerator* and
denominator** are positive.

Yes No

The numerator*, denominator**, or
both are negative.

No Yes

The denominator** is 0 (zero). No Yes

Avoiding pricing amplification

The inventory close process settles issue transactions to receipt transactions, based on the inventory valuation

method that is selected in the item’s item model group. However, before inventory close is run, the system

calculates a running average cost price that is typically used when issue transactions are posted.

The system estimates this running average cost price for an item by using the following formula:

Estimated price = (Physical amount + Financial amount) ÷ (Physical quantity + Financial quantity)

The following table shows when the system posts inventory transactions by using the running average cost

price, and when it uses the cost price that is defined on the item master record instead.

* Numerator = (Physical amount + Financial amount) ** Denominator = (Physical quantity + Financial quantity)

Note:Note: If the Include physical valueInclude physical value option isn't selected for an item, the system uses 0 (zero) for both the

physical amount and the physical quantity. For information about this option, see Include physical value.

On rare occasions, the system prices several issues before it has enough receipts to base the price on. This

scenario can cause estimates of the running average cost price to be overly inflated. However, there are steps

that you can take to avoid pricing amplification, or to reduce its impact when it does occur. ScenarioScenario The

following transactions occur for an item that you've selected the Include physical valueInclude physical value option for :

1. You financially receive a quantity of 100 at USD 100.00.

2. You financially issue a quantity of 200.

3. You physically receive a quantity of 101 at USD 202.00.

When you examine the estimated running average cost price for the item, you expect a cost price of USD 1.51.

Instead, you find an estimated running average of USD 102.00, which is based on the following formula:

Estimated price = [202 + (-100)] ÷ [101 + (-100)] = 102 ÷ 1 = 102 This pricing amplification occurs because,

when 200 items are issued financially in step 2, the system must price 100 of the items before it has any

corresponding receipts. This situation causes negative inventory. The system then estimates a unit price of USD

1.00, as we might expect. However, when the corresponding 100 receipts arrive, they are at a unit price of USD

2.00 each.

Note:Note: Although the issues create negative inventory, inventory is positive when the issue price is calculated.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/running-average-cost-price.md
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Therefore, the running average cost price is used instead of the price on the item master. At this point, the

system has an inventory value offset of USD 100.00. Although that offset was built up over 100 pieces, where

there was a unit offset of USD 1.00 each, we now have only one piece in inventory. Therefore, the offset of USD

100.00 is allocated to this one piece. The result is the overly inflated estimated cost price.

Note:Note: For comparison, notice that if steps 2 and 3 are reversed in the scenario, 200 items will be issued at a unit

price of USD 1.51, and one piece will remain at a unit price of USD 1.51. Because this pricing amplification

scenario can occur when negative inventory is involved, it's difficult to avoid in the following cases:

You must estimate issue prices on the on-hand value and quantity.

You must adjust the on-hand value and quantity on issues and receipts.

Your business model allows you to send out, or price, more pieces than you have.

You must accept any receipt value and quantity that are submitted to you.

However, if your business model allows for the following practices, they can help you avoid the negative

quantities that make the pricing amplification scenario possible:

If you select the Include physical valueInclude physical value option for an item, clear the Physical negative inventor yPhysical negative inventor y  check

box on the Item model groupsItem model groups  page.

If you do not select the Include physical valueInclude physical value option for an item, clear the Financial negativeFinancial negative

inventor yinventor y  option on the Item model groupsItem model groups  page.

Additionally, consider that the maximum offset in your physical inventory value is limited by the number of

physical transactions, and the difference between physical and financial prices. Provided that all physical

transactions are eventually updated financially, the physical value can't rise to extreme levels. Finally, note that

the amplification effect decreases significantly when the accumulated offset is spread out over several on-hand

pieces instead of just one.

Can you tell us about your documentation language preferences? Take a short survey.
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Use the Adjustment of on-hand inventory page to adjust the cost value of the on-hand inventory quantities after

an inventory close process is run.

You can use the Adjustment of on-hand inventor yAdjustment of on-hand inventor y  page to adjust the cost value of on-hand inventory

quantities after an inventory close process is run. Note:Note: To open the Adjustment of on-hand inventor yAdjustment of on-hand inventor y

page, on the Closing and adjustmentClosing and adjustment page, select the record of a completed inventory close process, and

then click AdjustmentAdjustment > On-handOn-hand. Example:Example: You have the following transactions in February:

February 1: An inventory financial receipt for a quantity of 2 at a cost of USD 10.00

February 5: An inventory financial receipt for a quantity of 1 at a cost of USD 13.00

February 19: An inventory financial issue for a quantity of 1 at a running average cost of USD 11.00

This item was set up with the first in, first out (FIFO) inventory model, and inventory close was performed as of

February 28. The financial issue transaction of USD 11.00 will be settled against the financial receipt that is

dated February 1, and an adjustment of USD 1.00 will be made. The following inventory receipts will then

contain open inventory quantities:

February 1: A quantity of 1 at a cost of USD 10.00

February 5: A quantity of 1 at a cost of USD 13.00

To set the cost of these two items to USD 15.00, use the on-hand adjustment option to adjust the open on-hand

quantities as of the last inventory close period. Note:Note: The posting date of the on-hand adjustment transaction

will be the date of the last inventory close. This date can't be modified.

Can you tell us about your documentation language preferences? Take a short survey.
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An inventory dimension group is attached to every inventory item. Therefore, the running average cost price of

an item is calculated based on the selected inventory dimensions that are being tracked financially.

There are three types of inventory dimensions: product, storage, and tracking. Product dimensions include

configuration, size, and color. Product dimensions are always tracked financially. Storage and tracking

dimensions include site, warehouse, location, inventory status, license plate, batch number, and serial number.

You can decide which storage and tracking dimensions are tracked financially.

Example 1Example 1

If the storage dimension group that is attached to the item is financially tracked by warehouse, the running

average cost price is calculated per warehouse. The following purchase orders have been invoiced:

A purchase order for a quantity of 2 at a cost price of USD 10.00 has been invoiced for warehouse GW.

A purchase order for a quantity of 3 at a cost price of USD 12.00 has been invoiced for warehouse GW.

A purchase order for a quantity of 5 at a cost price of USD 15.00 has been invoiced for warehouse MW.

The running average cost price for warehouse GW is USD 11.20, and the running average cost price for

warehouse MW is USD 15.00. A sales order invoice is posted for warehouse GW. The value of the inventory and

the cost of goods sold (before inventory close is run and without marking) is USD 11.20. Another sales order is

posted for warehouse MW. The value of the inventory and the cost of goods sold (before inventory close is run

and without marking) is USD 15.00.

Example 2Example 2  If the storage dimension group that is attached to the item is financially tracked by warehouse, and

the tracking dimension group is financially tracked by batch number, the running average cost price is calculated

for each batch.

Note:Note: We recommend that you always view the cost price for all financial dimensions that are being tracked.

The following purchase orders have been invoiced:

A purchase order for a quantity of 2 at a cost price of USD 10.00 has been invoiced for warehouse GW and

batch AAA.

A purchase order for a quantity of 3 at a cost price of USD 12.00 has been invoiced for warehouse GW and

batch AAA.

A purchase order for a quantity of 2 at a cost price of USD 15.00 has been invoiced for warehouse GW and

batch BBB.

The running average cost price for warehouse GW and batch AAA is USD 11.20, and the running average cost

price for warehouse GW and batch BBB is USD 15.00.
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Install the Inventory Visibility Add-in

PrerequisitesPrerequisites

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

Effective November 2020:

Common Data Service has been renamed to Microsoft Dataverse. For more information, see Power Automate Blog.

Some terminology in Microsoft Dataverse has been updated. For example, entity is now table and field is now column.

For more information, see Terminology updates.

This topic will be updated soon to reflect the latest terminology.

The Inventory Visibility Add-in is an independent and highly scalable microservice that enables real-time on-

hand inventory tracking, thus providing a global view of inventory visibility.

All information that relates to on-hand inventory is exported to the service in near real-time through low-level

SQL integration. External systems access the service through RESTful APIs to query on-hand information on

given sets of dimensions, thus retrieving a list of available on-hand positions.

Inventory Visibility is a microservice built on Microsoft Dataverse, which means you can extend it by building

Power Apps and applying Power BI to provide customized functionality to meet your business requirements. It is

also possible to upgrade the index to do inventory queries.

Inventory Visibility provides configuration options that let it integrate with multiple third-party systems. It

supports the standardized inventory dimension, customized extensibility, and standardized, configurable

calculated quantities.

This topic describes how to install and configure the Inventory Visibility Add-in for Dynamics 365 Supply Chain

Management, and how to use its application programming interface (API).

You need to install the Inventory Visibility Add-in using Microsoft Dynamics Lifecycle Services (LCS). LCS is a

collaboration portal that provides an environment and a set of regularly updated services that help you manage

the application lifecycle of your Dynamics 365 Finance and Operations apps.

For more information, see Lifecycle Services resources.

Before you install the Inventory Visibility Add-in, you must do the following:

Obtain an LCS implementation project with at least one environment deployed.

Generate the beta keys for your offering in LCS.

Enable the beta keys for your offering for your user in LCS.

Contact the Microsoft Inventory Visibility product team and provide an environment ID where you want to

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/inventory-visibility.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version
https://aka.ms/PAuAppBlog
https://go.microsoft.com/fwlink/?linkid=2147247
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/lifecycle-services/lcs
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deploy the Inventory Visibility Add-in.

If you have any questions about these prerequisites, please contact the Inventory Visibility product team.

To install the Inventory Visibility Add-in, do the following:

1. Sign in to the Lifecycle Services (LCS) portal.

2. On the home page, select the project where your environment is deployed.

3. On the project page, select the environment where you want to install the add-in.

4. On the environment page, scroll down until you see the Environment add-insEnvironment add-ins  section. If the section

isn't visible, make sure the prerequisite beta keys have been fully processed.

5. In the Environment add-insEnvironment add-ins  section, select Install a new add-inInstall a new add-in . 

6. Select the Install a new add-inInstall a new add-in link. A list of available add-ins opens.

7. Select Inventor y ser viceInventor y ser vice from the list. (Note, this may now be listed as Inventor y Visibility Add-inInventor y Visibility Add-in

for Dynamics 365 Supply Chain Managementfor Dynamics 365 Supply Chain Management.)

8. Enter values for the following fields for your environment:

AAD application IDAAD application ID

AAD tenant IDAAD tenant ID

https://lcs.dynamics.com/Logon/Index


Get a security service tokenGet a security service token

9. Agree to the terms and condition by selecting the Terms and conditionsTerms and conditions  check box.

10. Select InstallInstall . The status of the add-in will show as InstallingInstalling. When it's done, refresh the page to see

the status change to InstalledInstalled.

Get a security service token by doing the following:

{
"token_type": "Bearer",
"expires_in": "3599",
"ext_expires_in": "3599",
"expires_on": "1610466645",
"not_before": "1610462745",
"resource": "0cdb527f-a8d1-4bf8-9436-b352c68682b2",
"access_token": "eyJ0eX...8WQ"
}

1. Sign in to Azure Portal and use it to find the clientId  and clientSecret  for your Supply Chain

Management application.

2. Fetch an Azure Active Directory token ( aadToken ) by submitting an HTTP request with the following

properties:

KEYKEY VA L UEVA L UE

client_id ${aadAppId}

client_secret ${aadAppSecret}

grant_type client_credentials

resource 0cdb527f-a8d1-4bf8-9436-b352c68682b2

URLURL  - https://login.microsoftonline.com/${aadTenantId}/oauth2/token

MethodMethod - GET

Body content (form data)Body content (form data) :

3. You should receive an aadToken  in response, which resembles the following example.

4. Formulate a JSON request that resembles the following:
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Inventory Visibility Add-in public API

AuthenticationAuthentication

Configure the Inventory Visibility APIConfigure the Inventory Visibility API

{
    "grant_type": "client_credentials",
    "client_assertion_type":"aad_app",
    "client_assertion": "{Your_AADToken}",
    "scope":"https://inventoryservice.operations365.dynamics.com/.default",
    "context": "5dbf6cc8-255e-4de2-8a25-2101cd5649b4",
    "context_type": "finops-env"
}

{
    "access_token": "{Returned_Token}",
    "token_type": "bearer",
    "expires_in": 1200
}

Where:

The client_assertion  value must be the aadToken  you received in the previous step.

The context  value must be the environment ID where you want to deploy the add-in.

Set all of other values as shown in the example.

5. Submit an HTTP request with the following properties:

URLURL  - https://securityservice.operations365.dynamics.com/token

MethodMethod - POST

HTTP headerHTTP header  - Include the API version (key is Api-Version  and value is 1.0 )

Body contentBody content - Include the JSON request that you created in the previous step.

6. You will get an access_token  in response. This is what you need as a bearer token to call the Inventory

Visibility API. Here is an example.

To uninstall the add-in, select UninstallUninstall . Refresh LCS and the Inventory Visibility Add-in will be removed. The

uninstall process will remove the add-in registration and also start a job to clean up all of the business data

stored in the service.

The public REST API of the of the Inventory Visibility Add-in presents several specific endpoints of integration. It

supports three main interaction types:

Posting on-hand changes to the add-in from an external system.

Querying current on-hand quantities from an external system.

Automatic synchronization with Supply Chain Management on-hand.

The automatic synchronization isn't part of the public API but is instead handled in the background for

environments that have enabled the Inventory Visibility Add-in.

The platform security token is used to call the Inventory Visibility Add-in, so you must generate an Azure Active

Directory token using your Azure Active Directory application.

For more information about how to get the security token, see Install the Inventory Visibility Add-in.

Before using the service, you must complete the configurations described in the following subsections. The



  

  

PartitioningPartitioning

NOTENOTE

Dimension configurationsDimension configurations

DIM EN SIO N  T Y P EDIM EN SIO N  T Y P E DIM EN SIO N  N A M EDIM EN SIO N  N A M E

Product ColorId

Product SizeId

Product StyleId

Product ConfigId

Tracking BatchId

Tracking SerialId

Location LocationId

Location SiteId

Inventory Status StatusId

Warehouse Specific WMSLocationId

Warehouse Specific WMSPalletId

Warehouse Specific LicensePlateId

configuration may vary based on the details of your environment. It primarily includes four parts:

Partitioning

Dimension configurations

Indexing

Custom measurement

Partitioning can significantly influence the performance of the Inventory Visibility API. It's a good idea to define a

scheme that allows for small groupings of data while still allowing for meaningful data queries.

The organizationId  ( dataAreaId  in Supply Chain Management) will always be part of the partitioning, and by

default Inventory Visibility is set to partition by dimensions as Site + Location. This means that the service must

always be queried with these dimensions defined on the filters.

Site and Location are two general default dimensions in Inventory Visibility. In Supply Chain Management, those

dimensions are called Site ( InventSiteId ) and Warehouse ( InventLocationId )

Inventory Visibility will provide a list of general default dimensions to enable the multiple source system

integration.

The following table lists the inventory dimensions that will be the default dimension names in Inventory

Visibility.
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IndexingIndexing

NOTENOTE

The dimension type listed in the previous table is for reference only. You don't need to define the dimension type in

Inventory Visibility.

If a custom dimension exists and needs to flow to a default value when consumed by Inventory Visibility, you

can configure the Custom dimensionCustom dimension name in Inventory Visibility.

External systems access Inventory Visibility through RESTful APIs that enable on-hand information on given sets

of dimensions to be queried. For the integration, Inventory Visibility enables you to configure the external

channel data source and the source dimension to the target dimensions in Inventory Visibility.

The target dimensions should be one of the following:

Default dimensions in Inventory Visibility

Custom dimensions

The purpose of dimension configuration is to standardize the multi-system integration for the query on

dimensions and the posting event with dimensions.

Most of the time, the inventory on-hand query will not only be on the highest "total" level, but you may want to

see results aggregated based on the inventory dimensions.

Inventory Visibility provides flexibility by allowing you to set up the indexes, which are based on the dimension

or the combination of the dimensions.

Currently, you can only configure indexes to a maximum of five. You need to carefully consider which dimension or

dimension combination you will use before the implementation to ensure that it will meet your business needs. For

example, if you want to query products as follows:

Query the aggregated product on-hand by the Color and Size dimensions.

In some cases, you just want to query on the product in total.

You would have two indexes defined as the following:

["ColorId", "SizeId"]

[]

The empty bracket will aggregate based on the product ID within the partition.

The indexing defines how you can group your results based on the groupBy  query setting. In this case if you

don't define any groupBy  values, you'll get totals by productid . Otherwise if you define groupBy  as 

groupBy=ColorId&groupBy=SizeId , you'll get multiple lines returned, based on the different color and size

combinations in the system.

You can put your query criteria in the request body.

Here is a sample query on the product with color and size combination.



  

{
    "filters": {
        "OrganizationId": ["usmf"],
        "ProductId": ["MyProduct"],
        "LocationId": ["21"],
        "SiteId": ["2"],
        "ColorId": ["Red"]
    },
    "groupByValues": [
        "SizeId",
        "ColorId"
    ],
    "returnNegative": true
}

Custom measurementCustom measurement

[
    {
        "productId": "MyProduct",
        "dimensions": {
            "colorid": "Red"
        },
        "quantities": {
            "mypos": {
                "outbound": 20.0,
                "inbound": 80.0
            },
            "fno": {
                "availphysical": 100.0,
                "orderedintotal": 50.0,
                "orderedreserved": 10.0
            },
            "exterchannel": {
                "received": 90.0,
                "scheduled": 30.0,
                "issued": 60.0,
                "reserved": 40.0
            }
        }
    }
]

C O N SUM P T IO NC O N SUM P T IO N
SY ST EMSY ST EM

C A L C UL AT EDC A L C UL AT ED
M EA SURERSM EA SURERS DATA  SO URC EDATA  SO URC E M O DIF IERM O DIF IER

M O DIF IERM O DIF IER
C A L C UL AT IO N  T Y P EC A L C UL AT IO N  T Y P E

CustomChannel MyCustomAvailableforReservationfno availphysical Addition

CustomChannel MyCustomAvailableforReservationfno orderedintotal Addition

The default measurement quantities are linked to Supply Chain Management, however you may want to have a

quantity that is made up of a combination of the default measurements. To do this, you can have a configuration

of custom quantities, which will be added to the output of the on-hand queries.

The functionality simply allows you to define a set of measures that will be added, and/or a set of measures that

will be subtracted, in order to form the custom measurement.

For example, with the following query condition, you will configure the custom measurement quantity as 

MyCustomAvailableforReservation  to be consumed by the consumption system.



CustomChannel MyCustomAvailableforReservationfno orderedreserved Subtraction

CustomChannel MyCustomAvailableforReservationmypos inbound Addition

CustomChannel MyCustomAvailableforReservationmypos outbound Subtraction

CustomChannel MyCustomAvailableforReservationexterchannel received Addition

CustomChannel MyCustomAvailableforReservationexterchannel scheduled Addition

CustomChannel MyCustomAvailableforReservationexterchannel issued Subtraction

CustomChannel MyCustomAvailableforReservationexterchannel reserved Subtraction

C O N SUM P T IO NC O N SUM P T IO N
SY ST EMSY ST EM

C A L C UL AT EDC A L C UL AT ED
M EA SURERSM EA SURERS DATA  SO URC EDATA  SO URC E M O DIF IERM O DIF IER

M O DIF IERM O DIF IER
C A L C UL AT IO N  T Y P EC A L C UL AT IO N  T Y P E

[
    {
        "productId": "MyProduct",
        "dimensions": {
            "colorid": "Red"
        },
        "quantities": {
            "mypos": {
                "outbound": 20.0,
                "inbound": 80.0
            },
            "fno": {
                "availphysical": 100.0,
                "orderedintotal": 50.0,
                "orderedreserved": 10.0
            },
            "exterchannel": {
                "received": 90.0,
                "scheduled": 30.0,
                "issued": 60.0,
                "reserved": 40.0
            },
            "CustomChannel": {
                "MyCustomAvailableforReservation": 220.0
            }
        }
    }
]

Posting on-hand changesPosting on-hand changes

With that, the query on the custom measurement quantity will return the following output.

The MyCustomAvailableforReservation  output is based on the calculation setting in the custom measurements as:

100 + 50 + 80 + 90 + 30 – 10 – 20 – 60 – 40 = 220

The exact URL that the event will be posted to will depend on your geographical region. It will take the form:

https://{serviceURL}/api/environment/{environmentId}/onhand

When authenticated, this URL can be used along with the HTTP POST  method to send on-hand change events to

the service.



Posting on-hand changes query example 1Posting on-hand changes query example 1

{
    "PosSizeId": "SizeId",
    "PosColorId": "ColorId",
    "PosSiteId": "SiteId",
    "PosLocationId": "LocationId"
}

{
    "id": "demo-test-00007",
    "organizationId": "usmf",
    "productId": "MyProduct",
    "quantities": {
        "pos": {
            "Outbound": 1
        }
    },
    "dimensionDataSource": "pos",
    "dimensions": {
        "PosSizeId": "Large",
        "PosColorId": "Red",
        "PosSiteId": "2",
        "PosLocationId": "21"
    }
}

Posting on-hand changes query example 2Posting on-hand changes query example 2

{
    "id": "demo-test-00007",
    "organizationId": "usmf",
    "productId": "MyProduct",
    "quantities": {
        "pos": {
            "Outbound": 1
        }
    },
    "dimensions": {
        "SizeId": "Large",
        "ColorId": "Red",
        "SiteId": "2",
        "LocationId": "21"
    }
}

JSON document field propertiesJSON document field properties

A special header is used for communicating with Dynamics 365 services through HTTP requests, denoting the

environment ID of the Supply Chain Management instance the data is linked to. For example:

x-ms-environment-id: 2db79622-f97a-4d64-9844-d12efed41796

This example shows a scenario where you will set up the dimension configuration in Power Apps.

Use the following query to configure the dimension mapping in Power Apps:

Now you can specify the dimensionDataSource  and use custom dimensions in your queries. The system will

automatically convert custom dimensions to base dimensions.

This example shows a scenario where no mappings are set up for the dimension configuration in Power Apps,

so the posting should also use the base dimensions. All dimensions must be base dimensions when the 

dimensionDataSource  field is null, empty, or whitespace.



F IEL D IDF IEL D ID DESC RIP T IO NDESC RIP T IO N

id A unique ID for the specific change event. This ID is used to
ensure that if communication with the service fails during
posting, resubmitting the event would not result in the same
event being counted twice in the system.

organizationId The identifier of the organization linked to the event. This
maps to Supply Chain Management organizations or data
area IDs.

productId The identifier of the product in question.

quantity The quantity by which the on-hand needs to be changed. If,
for instance, 10 new bagels were added to a shelf, this value
would be 10. If 3 bagels were then removed from the shelf
or sold, this value would be -3.

dimensionDataSource The data source of the dimensions used in the posting
change event and query. If you specify the data source, you
can use the custom dimensions from the specified data
source. With the dimension configuration, Inventory
Visibility can map the custom dimensions to the general
default dimensions. If the dimensionDataSource  is not

specified, you can only use the general default dimensions in
your queries.

dimensions A dynamic bag of key/value pairs. These will map to some of
the dimensions in Supply Chain Management, but you could
also add custom dimensions (like Source) that may denote if
the event was coming from Supply Chain Management or
an external system.

Querying current on-handQuerying current on-hand

Current on-hand query example 1Current on-hand query example 1

{
    "PosSizeId": "SizeId",
    "PosColorId": "ColorId",
    "PosSiteId": "SiteId",
    "PosLocationId": "LocationId"
}

The fields from the JSON query examples provided previously have the properties listed in the following table.

The endpoint for querying the current on-hand will have a similar URL:

https://{serviceURL}/api/environment/{environmentId}/onhand/indexquery

It will be queried with the HTTP POST  method.

This example shows a scenario where you have already completed the dimension configuration in Power Apps.

Use the following query to configure the dimension mapping in Power Apps:

Now you can specify the dimensionDataSource  and use custom dimensions in your queries. The system will

automatically convert custom dimensions to base dimensions. You can specify the DimensionDataSource  in 

filters  and specify custom dimensions in both filters  and groupByValues . The system will automatically

convert custom dimensions to base dimensions.



{
    "filters": {
        "OrganizationId": ["usmf"],
        "ProductId": ["MyProduct"],
        "DimensionDataSource": ["Pos"],
        "PosLocationId": ["21"],
        "PosSiteId": ["2"],
        "PosColorId": ["Red"]
    },
    "groupByValues": [
        "PosSizeId",
        "PosColorId"
    ],
    "returnNegative": true
}

Current on-hand query example 2Current on-hand query example 2

{
    "filters": {
        "OrganizationId": ["usmf"],
        "ProductId": ["MyProduct"],
        "LocationId": ["21"],
        "SiteId": ["2"],
        "ColorId": ["Red"]
    },
    "groupByValues": [
        "SizeId",
        "ColorId"
    ],
    "returnNegative": true
}

Example return resultExample return result

This example shows a scenario where no mappings are set up for the dimension configuration in Power Apps,

so the posting should also use the base dimensions. All dimensions must be base dimensions when the 

dimensionDataSource  field, under filters  is null, empty, or whitespace.

The queries shown in the previous examples could return a result like this.



[
    {
        "productId": "MyProduct",
        "dimensions": {
            "colorid": "Red"
        },
        "quantities": {
            "mypos": {
                "outbound": 20.0,
                "inbound": 80.0
            },
            "fno": {
                "availphysical": 100.0,
                "orderedintotal": 50.0,
                "orderedreserved": 10.0
            },
            "exterchannel": {
                "received": 90.0,
                "scheduled": 30.0,
                "issued": 60.0,
                "reserved": 40.0
            },
            "CustomChannel": {
                "MyCustomAvailableforReservation": 220.0
            }
        }
    }
]

NOTENOTE

Note that the quantities fields are structured as a dictionary of measures and their associated values.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


IoT Intelligence home page
2/18/2021 • 2 minutes to read • Edit Online

IMPORTANTIMPORTANT

Setup

This feature is currently only available in the following countries/regions:

US (United States of America)

EU (European Union)

AU (Australia)

CA (Canada)

UK (United Kingdom)

IoT Intelligence is an add-in for Microsoft Dynamics 365 Supply Chain Management. It integrates Internet of

Things (IoT) signals with data in Supply Chain Management to produce actionable insights.

IoT Intelligence supports the following scenarios:

Production delaysProduction delays  – This scenario compares actual cycle time to planned cycle time. Supply Chain

Management notifies you when production isn't on schedule, so that you can intervene to maximize

operating efficiency and avoid order delays.

Equipment downtimeEquipment downtime – This scenario compares measured uptime to user-defined parameters. Supply

Chain Management notifies you when an outage threshold is exceeded, so that you can take actions such as

rescheduling a production work order or creating a maintenance work order.

Product qualityProduct quality  – This scenario compares sensor readings, such as moisture and temperature, to user-

defined quality metrics. Supply Chain Management notifies you when a deviation occurs, so that you can

intervene to maintain quality standards and minimize waste.

The following illustration shows the interaction of Azure IoT Hub, IoT Intelligence, and Supply Chain

Management.

You can set up and configure IoT Intelligence without writing any code. Here are the basic steps.

1. Set up Azure resources – Create an IoT hub, a Redis cache, and a key vault that can be accessed from Supply

Chain Management.

2. Message schema formats for IoT Hub – Configure your devices to send messages to IoT Hub, and define the

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/iot/iot-intelligence-home-page.md


Tracking and maintenance

NOTENOTE

JavaScript Object Notation (JSON) message format.

3. In Feature Management, enable the IoT Intelligence feature flag.

4. Install the IoT Intelligence add-in in Microsoft Dynamics Lifecycle Services (LCS) – Install the add-in in LCS,

and configure the Azure secrets.

5. Set up metrics – Set up metrics in Supply Chain Management.

6. Scenario setup – Set up the scenarios in Supply Chain Management.

Monitor scenarios in Dynamics 365 Supply Chain Management

Disable a scenario

Uninstall the add-in

Modify a running IoT Intelligence scenario

Simulation options

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Create Azure resources

Verify that the Microsoft Dynamics ERP Microservices first-party app ID is in your tenantVerify that the Microsoft Dynamics ERP Microservices first-party app ID is in your tenant

Create a key vault resourceCreate a key vault resource

Create an IoT hub resourceCreate an IoT hub resource

This topic explains how to create and configure the Microsoft Azure resources that you require for IoT

Intelligence.

Follow these steps to create an IoT hub, a Redis cache, and a key vault that can be accessed by Microsoft

Dynamics 365 Supply Chain Management.

To verify that the app ID for the Microsoft Dynamics ERP Microservices first-party app is in your tenant, follow

these steps.

1. Sign in to the Azure portal at https://portal.azure.com.

2. Go to Azure Active Director yAzure Active Director y .

3. Go to Enterprise applicationsEnterprise applications .

4. In the Application typeApplication type field, select Microsoft applicationsMicrosoft applications .

5. In the search field, enter Microsoft Dynamics ERP Microser vicesMicrosoft Dynamics ERP Microser vices .

6. Verify that Microsoft Dynamics ERP Microser vicesMicrosoft Dynamics ERP Microser vices  is in the list. Other applications have similar

names. Therefore, make sure that you find the correct application. The app ID is 0cdb527f-a8d1-4bf8-0cdb527f-a8d1-4bf8-

9436-b352c68682b29436-b352c68682b2 .

If the application isn't in the list, you must add it to your tenant:

a. In the Azure portal, on the toolbar, select the button to open Azure Cloud Shell.

b. Run the command Install-Module AzureADInstall-Module AzureAD. Enter YY  to install the module.

c. Run the command Get-InstalledModule -Name "AzureAD"Get-InstalledModule -Name "AzureAD" to verify that the module is installed.

d. Run the command Connect-AzureAD -ConfirmConnect-AzureAD -Confirm to run the authentication.

e. Run the command New-AzureADSer vicePrincipal -AppId 0cdb527f-a8d1-4bf8-9436-New-AzureADSer vicePrincipal -AppId 0cdb527f-a8d1-4bf8-9436-

b352c68682b2b352c68682b2 .

You can now repeat steps 1 through 6 to verify that the app ID is in your tenant.

To create a key vault resource, follow these steps.

1. In the Azure portal, create or go to a resource group.

2. Select AddAdd.

3. On the NewNew  page, in the search field, enter Key vaultKey vault. Then select CreateCreate.

4. On the Create key vaultCreate key vault page, in the Key vault nameKey vault name field, enter a name.

5. Review the default values, and then select Review + createReview + create.

6. Select CreateCreate.

The key vault is created in the background.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/iot/iot-azure-setup.md
https://portal.azure.com
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Create a Redis cache resourceCreate a Redis cache resource

NOTENOTE

Configure the Azure resources
Configure the IoT hubConfigure the IoT hub

Configure the key vaultConfigure the key vault

To create an IoT hub resource, follow these steps.

1. Create or go to a resource group.

2. Select AddAdd.

3. On the NewNew  page, in the search field, enter Iot HubIot Hub. Then select CreateCreate.

4. In the IoT hub nameIoT hub name field, enter a name.

5. Review the default values, and then select Review + createReview + create.

6. Select CreateCreate.

The IoT hub is created in the background.

We recommend that you create only one IoT hub resource per environment.

To create a Redis cache resource, follow these steps.

1. Create or go to a resource group.

2. Select AddAdd.

3. On the NewNew  page, in the search field, enter Azure Cache for RedisAzure Cache for Redis . Then select CreateCreate.

4. In the DNS nameDNS name field, enter a name.

5. Review the default values, and then select CreateCreate.

The Redis cache is created in the background.

We recommend that you create only one Redis cache per environment.

All the resources have now been created.

To configure the IoT hub, follow these steps.

1. In your resources, select the IoT hub resource.

2. In the left navigation pane, select Built-in endpointsBuilt-in endpoints .

3. Under Consumer groupsConsumer groups , paste the following consumer groups. These consumer groups correspond to

the out-of-box scenarios.

microsoft.dynamics.iotintelligence-1

microsoft.dynamics.iotintelligence-2

microsoft.dynamics.iotintelligence-3

To configure the key vault, follow these steps.

1. In your resources, select the key vault resource.

2. In the left navigation pane, select Access policiesAccess policies .

3. Select Add an access policyAdd an access policy .



Save the IoT hub connection string secretSave the IoT hub connection string secret

Save the Redis cache connection string secretSave the Redis cache connection string secret

NOTENOTE

NOTENOTE

4. On the Add access policyAdd access policy  page, in the Secret permissionsSecret permissions  field, select GetGet and L istL ist.

5. Click in the Select pr incipalSelect pr incipal .

6. In the Pr incipalPr incipal  dialog box, search for and select Microsoft Dynamics ERP Microser vicesMicrosoft Dynamics ERP Microser vices . Then select

SelectSelect.

7. Select AddAdd.

8. Select SaveSave.

The app now has access to the secrets in the key vault.

To save the secret for the IoT hub connection string, follow these steps.

1. In your resources, select the IoT hub resource.

2. In the left navigation pane, select Built-in endpointsBuilt-in endpoints .

3. Copy the value in the Event Hub-compatible endpointEvent Hub-compatible endpoint field.

4. Go to the key vault resource.

5. In the left navigation pane, select SecretsSecrets .

6. Select Generate/Impor tGenerate/Impor t.

7. In the NameName field, enter a name.

8. In the ValueValue field, paste the endpoint value that you copied earlier.

9. Select CreateCreate.

To save the secret for the Redis cache connection string, follow these steps.

1. In your resources, select the Redis cache resource.

2. Select Access keysAccess keys .

3. Copy the value in the Pr imar y connection str ingPrimar y connection str ing field.

4. Go to the key vault resource.

5. In the left navigation pane, select SecretsSecrets .

6. Select Generate/Impor tGenerate/Impor t.

7. In the NameName field, enter a name.

8. In the ValueValue field, paste the connection string that you copied earlier.

9. Select CreateCreate.

Whenever you update one of the connection strings, you must also update the secret values.

You've now finished provisioning the required Azure resources. The next step is to install the IoT Intelligence

add-in in Microsoft Dynamics Lifecycle Services (LCS).

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Message requirements

This topic explains how you should design a message schema that you can use in IoT Intelligence.

The following rules apply to the monitoring of messages in IoT Intelligence:

{
    "id": "IoTInt.Machine1225.PartOut",
    "timestamp": 1576016821614,
    "value": True
}

{
    "id": "IoTInt.Machine1225.PartOut",
    "timestamp": 1576016821614,
}

{
    "id": "IoTInt.Machine1225.PartOut",
    "timestamp": 1576016821614,
    "value": True
},
{
    "id": "IoTInt.Machine1225.PartOut",
    "timestamp": 1576016821614,
    "value": True,
    "machine" : "Machine1225",
},
{
    "id": "IoTInt.Machine1225.PartOut",
    "timestamp": 1576016821614,
    "value": True,
     "activity": "PartOut"
},

Message schemas must be in JavaScript Object Notation (JSON) format.

A UNIX timestamptimestamp property, where the value is expressed in milliseconds (ms), must be present in the

Microsoft Azure IoT Hub message.

A message is tracked only if it contains all the properties that are defined in the scenario setup. For

example, if you define idid, timestamptimestamp, and valuevalue properties, the following message is monitored.

This message isn't monitored, because the valuevalue property is missing.

IoT Intelligence ignores properties in the message that aren't defined in the scenario configuration. For

example, if you define idid, timestamptimestamp, and valuevalue properties, IoT Intelligence will monitor all the

following messages.

IoT Intelligence silently ignores messages that don't match the scenario configuration criteria.

You can define and use multiple types of message schemas.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/iot/iot-schema-format.md


Id-value pair schema

{
    "id": "IoTInt.Machine1225.PartOut",
    "timestamp": 1576016821614,
    "value": True
}

{
    "id": "IoTInt.Machine1225.Temperature",
    "timestamp": 1576016821614,
    "value": 105
}

NOTENOTE

Not every type of message schema must be defined. Only schemas that will be used for the IoT

Intelligence scenarios must be defined.

An id-value pair is a common pattern for IoT Intelligence message schemas. By using an id-value pair, you

ensure that your message schema is the same across all the scenarios. For example, here is a message for the

Equipment downtimeEquipment downtime or Production delaysProduction delays  scenario.

Here is a message for the Product qualityProduct quality  scenario.

Both the preceding messages contain idid and valuevalue properties. The idid values can be mapped in the S ignal DataSignal Data

ValuesValues  table during scenario setup. For the Equipment downtimeEquipment downtime scenario, you will map the

IoTInt.Machine1225.Par tOutIoTInt.Machine1225.Par tOut value. For the Product qualityProduct quality  scenario, you will map the

IoTInt.Machine1225.TemperatureIoTInt.Machine1225.Temperature value.

For more information, see Azure IoT Hub Documentation.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Set up the LCS environment

Uninstall the add-in

This topic explains how to install the IoT Intelligence add-in in Microsoft Dynamics Lifecycle Services (LCS). Note

that add-ins cannot be installed on a demo/trial environment. Before you can install the add-in, you must create

the Azure resources.

1. Open LCS, and go to your Microsoft Dynamics 365 Supply Chain Management environment.

2. Scroll to the Environment add-insEnvironment add-ins  section.

3. Select Install a new add-inInstall a new add-in to show the list of add-ins that have been enabled for the environment.

4. In the Select an add-in to installSelect an add-in to install  dialog box, select IoT IntelligenceIoT Intelligence.

5. In the Setup add-inSetup add-in dialog box, provide the details of your IoT hub and Redis cache. You can find the

required values in the key vault that you created in Create Azure resources.

Tenant IDTenant ID – In the Azure portal, go to the key vault, and then, in the left navigation pane, select

Over viewOver view , and copy the Director y IDDirector y ID value. Paste that value in the Setup add-inSetup add-in dialog box.

IoT Event Hub-compatible endpoint Key Vault URIIoT Event Hub-compatible endpoint Key Vault URI – Go to the key vault, and then, in the left

navigation pane, select Over viewOver view , and copy the DNS nameDNS name value. Paste that value in the SetupSetup

add-inadd-in dialog box.

IoT Event Hub-compatible endpoint secret nameIoT Event Hub-compatible endpoint secret name – Go to the key vault, and then, in the left

navigation pane, select SecretsSecrets , and copy the name of the secret where the event hub connection

string for the IoT hub is stored. Paste that value in the Setup add-inSetup add-in dialog box.

Redis cache key vault URIRedis cache key vault URI – Go to the key vault, and then, in the left navigation pane, select

Over viewOver view , and copy the DNS nameDNS name value. Paste that value in the Setup add-inSetup add-in dialog box.

Redis cache endpoint secret nameRedis cache endpoint secret name – Go to the key vault, and then, in the left navigation pane,

select SecretsSecrets , and copy the name of the secret where the connection string for the Redis cache is

stored. Paste that value in the Setup add-inSetup add-in dialog box.

6. Select the check box to accept the terms and conditions.

7. Select InstallInstall .

8. A message box appears that states, "Add-in has been successfully triggered for installation." Select OKOK.

LCS setup is now completed. The next step is to set up the scenarios.

1. In Supply Chain Management, disable the scenarios.

2. In LCS, go to your Supply Chain Management environment details.

3. Scroll to the Environment add-insEnvironment add-ins  section.

4. Select UninstallUninstall  for the IoT Intelligence add-in.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/iot/iot-lcs-setup.md
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Configure metrics

Configure the Resource Status time series

If you want to view the time series charts of your messages in Microsoft Dynamics 365 Supply Chain

Management, you must set up the metrics by following these steps.

NOTENOTE

1. Copy the connection string for the Redis cache:

a. In the Azure portal, go to the Redis cache.

b. Go to SettingsSettings  > Access keysAccess keys .

c. Copy the value in the Pr imar y connection str ingPrimar y connection str ing field.

2. In Supply Chain Management, go to Production control > Setup > IoT Intelligence > ScenarioProduction control > Setup > IoT Intelligence > Scenario

parametersparameters .

3. On the Scenario parametersScenario parameters  page, on the Time ser iesTime ser ies  tab, in the Redis metr ic store connectionRedis metr ic store connection

str ingstr ing field, paste the connection string that you copied earlier. This step enables the metrics from Azure

IoT Hub to be visualized in Supply Chain Management. When you paste the value into the field, it's shown

as ************ .

Whenever you update the Redis cache connection string, you must also update this field.

4. Go to Production control > Inquir ies and repor ts > IoT Intelligence > Metr ic keysProduction control > Inquir ies and repor ts > IoT Intelligence > Metr ic keys .

5. On the Metr ic keysMetr ic keys  page, select UpdateUpdate.

6. In the Update metr ic keysUpdate metr ic keys  dialog box, notice that Run in the backgroundRun in the background is selected in the field.

Select OKOK.

All the metric keys in the Redis cache are retrieved and added to the Metr ic keysMetr ic keys  list. Metric values won't

appear until you enable the scenarios.

To configure the Resource StatusResource Status  time series, follow these steps.

1. In Supply Chain Management, go to Production control > Manufactur ing execution > ResourceProduction control > Manufactur ing execution > Resource

StatusStatus .

2. On the Resource statusResource status  page, select ConfigureConfigure.

3. In the ConfigureConfigure dialog box, in the ResourceResource list, select an item to monitor.

4. Select the EditEdit button for Time ser ies 1Time ser ies 1 .

5. In the Select time ser iesSelect time ser ies  dialog box, select a metric in the grid. (You can also use the Update metr ic keysUpdate metr ic keys

link to update the metric keys from this dialog box.)

6. Select OKOK to return to the ConfigureConfigure dialog box.

7. Enter a display name.

8. In the Show data fromShow data from field, select a time frame.

9. Select OKOK.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/iot/iot-metrics-setup.md


Delete a metric key
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The chart is shown.

1. In Supply Chain Management, go to Production control > Inquir ies and repor ts > IoT Intelligence >Production control > Inquir ies and repor ts > IoT Intelligence >

Metr ic keysMetr ic keys .

2. On the Metr ic keysMetr ic keys  page, select the metric key to delete.

3. Select DeleteDelete.
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Configure the Equipment downtime scenario in Supply Chain
Management

This topic explains how to configure scenarios for IoT Intelligence in Microsoft Dynamics 365 Supply Chain

Management. Before you can set up the scenarios, you must set up Microsoft Dynamics Lifecycle Services (LCS).

In this topic, you will configure the Equipment downtimeEquipment downtime scenario so that a notification is generated in Supply

Chain Management when a machine goes down. The topic also shows how to configure the Product qualityProduct quality

scenario so that a notification is generated if an attribute of an item is outside a specified range, and how to

configure the Production delaysProduction delays  scenario so that a notification is generated if the production throughput falls

below a threshold value.

The Equipment downtimeEquipment downtime scenario maps a Par tOutPar tOut signal to a machine alert threshold. The machine is

monitored only when it's selected for the scenario and when is set to RunningRunning in Supply Chain Management. If

the time since a Par tOutPar tOut signal was last received from the machine exceeds the alert threshold, a MachineMachine

downdown notification is triggered. If the machine is still running, a Machine upMachine up notification is triggered when the

next Par tOutPar tOut signal is received. If a machine stays down for 30 minutes, a new Machine downMachine down notification is

triggered.

The Equipment downtimeEquipment downtime scenario has the following dependencies:

An alert can be triggered only if a production order is running on a mapped machine.

A signal that represents a mapped machine's Par tOutPar tOut signal must be sent to the IoT hub, and a unique

property name must be included.

A UNIX timestamptimestamp property, where the value is expressed in milliseconds (ms), must be present in the

Azure IoT Hub message.

To configure the scenario, follow these steps.

1. Sign in to Supply Chain Management.

2. Enable the IoT Intelligence feature flag. For more information, see Feature management overview.

3. Configure the metrics. For more information, see How to configure metrics.

4. Go to Production control > Setup > IoT Intelligence > Scenario managementProduction control > Setup > IoT Intelligence > Scenario management.

5. On the Equipment downtimeEquipment downtime tile, select ConfigureConfigure to open the configuration wizard.

The first page in the wizard is the Equipment sensor schema definitionEquipment sensor schema definition page. On this page, your goal

is to set up the schema in Supply Chain Management so that it matches the JavaScript Object Notation

(JSON) format of the IoT Hub messages. Multiple message schemas can be defined. For more

information, see Schema formats for IoT Hub messages. In this example, the message payload contains a

batch of messages that has the following format.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/iot/iot-scenario-setup.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/feature-management/feature-management-overview


{
    "timestamp": 1576016821614,
    "payload": [
        {
            "id": "IoTInt.Machine1225.PartOut",
            "timestamp": 1576016821614,
            "value": True
        },
        {
            "id": "IoTInt.Machine1226.PartOut",
            "timestamp": 1576016991616,
            "value": True
        }
    ]
}
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6. Add a row to the table, and set the following values:

a. Set the Schema nameSchema name field to IDID.

b. Set the Schema pathSchema path field to /payload[*]/id/payload[*]/id.

c. Set the Descr iptionDescr iption field to Message IDMessage ID.

7. Add another row to the table, and set the following values:

a. Set the Schema nameSchema name field to TimestampTimestamp.

b. Set the Schema pathSchema path field to /payload[*]/timestamp/payload[*]/timestamp.

c. Set the Descr iptionDescr iption field to Message timestampMessage timestamp.

8. Add another row to the table, and set the following values:

a. Set the Schema nameSchema name field to ValueValue.

b. Set the Schema pathSchema path field to /payload[*]/value/payload[*]/value.

c. Set the Descr iptionDescr iption field to Message valueMessage value.

You don't have to define all the properties in the message. Define only the properties that you require. In the

preceding steps, you didn't create a row for Root timestampRoot timestamp. The path of Root timestampRoot timestamp would be

/timestamp/timestamp.

9. Select NextNext to go to the Equipment sensor schema mapEquipment sensor schema map page.

10. In the row for Equipment resource IDEquipment resource ID, in the Schema nameSchema name field, select IDID.

11. In the row for UTC timeUTC time, in the Schema nameSchema name field, select TimestampTimestamp.

12. In the row for Par t produced signalPar t produced signal , in the Schema nameSchema name field, select ValueValue.

13. Select NextNext to go to the Equipment resource ID configurationEquipment resource ID configuration page.

14. Follow these steps to map the values in the IoT Hub message to the Supply Chain Management

resources:

a. In the S ignal Data ValuesSignal Data Values  table, add a new row. In the ValueValue field, enter

IoTInt.Machine1225.Par tOutIoTInt.Machine1225.Par tOut. This value comes from the JSON idid property in the IoT Hub message.

b. Select SaveSave.

c. In the Business Record MappingBusiness Record Mapping table, select NewNew . A default value for the Business record typeBusiness record type

field is automatically filled in, and you don't have to change it.

d. In the Business recordBusiness record field, select the Supply Chain Management machine resource that the signal



Configure the Product quality scenario in Supply Chain Management

Configure the Production delays scenario in Supply Chain
Management

value is being sent from.

e. Select SaveSave.

f. Repeat these steps to add a new business record mapping for Machine1226Machine1226 . You can map multiple

signal data values to a single record in Supply Chain Management.

15. Use the SelectedSelected column to select the machines that you want to process. You don't have to define all

signal values, and you don't have to select all machines.

16. Select NextNext to go to the Par t produced signal configurationPar t produced signal configuration page.

17. In the S ignal Data ValuesSignal Data Values  table, add a row, and set the ValueValue field to TrueTrue. This value comes from the

JSON valuevalue property in the IoT Hub message. You can add as many values as you require for your

scenario.

18. Select SaveSave.

19. Select NextNext to go to the Equipment downtime thresholdEquipment downtime threshold page. The machines that are listed are the

machines that were previously mapped to signal values. On this page, you will define a threshold to

determine whether a machine is down. For example, if you set the threshold to 1010 , Supply Chain

Management will generate a notification if no Par tOutPar tOut signal is received from a machine for 10 minutes.

20. Select NextNext to go to the Enable scenarioEnable scenario page. Set the option to enable the scenario.

21. Select FinishFinish .

The scenario setup is now completed. IoT Intelligence will automatically start to process the IoT Hub messages.

The Product qualityProduct quality  scenario generates a notification if an attribute of an item is outside a specified range. For

example, a sensor sends the weight of each item to IoT Hub. If an item is too heavy or too light, a notification is

generated in Supply Chain Management.

The Product qualityProduct quality  scenario has the following dependencies:

An alert can be triggered only if a production order is running on a mapped machine and producing a

product that has a mapped batch attribute.

A signal that represents the batch attribute must be sent to the IoT hub, and a unique property name must be

included.

A UNIX timestamptimestamp property, where the value is expressed in ms, must be present in the IoT Hub message.

The Production delaysProduction delays  scenario generates a notification if the production throughput falls below a threshold

value. In this scenario, a Par tOutPar tOut signal is sent to IoT Hub for each item that is produced. In Supply Chain

Management, the order delay is calculated based on the amount of time that the production order is scheduled

to run, the number of items that should be produced, the amount of time that the job has been running, and the

number of Par tOutPar tOut signals that are received. A delay notification is generated if the number of Par tOutPar tOut signals

for the job falls below the threshold value.

The Production delaysProduction delays  scenario has the following dependencies:

An alert can be triggered only if a production order is running on a mapped machine.

A signal that represents a mapped machine's Par tOutPar tOut signal must be sent to the Azure IoT hub, and a unique

property name must be included.

A UNIX timestamptimestamp property, where the value is expressed in ms, must be present in the IoT Hub message.



    Disable a scenario
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To disable a scenario, follow these steps.

1. In Supply Chain Management, go to Production control > Setup > IoT Intelligence > ScenarioProduction control > Setup > IoT Intelligence > Scenario

managementmanagement.

2. On the tile for the scenario, select ConfigureConfigure.

3. Select NextNext to go to the last wizard page.

4. Set the option to disable the scenario.
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Monitor scenarios in Microsoft Dynamics 365 Supply Chain
Management

Modify a running IoT Intelligence scenario

Simulation options

This topic explains how to monitor and manage IoT Intelligence.

You can monitor IoT Intelligence processing from several places:

Modules > Production control > Inquir ies and repor ts > IoT Intelligence > NotificationsModules > Production control > Inquir ies and repor ts > IoT Intelligence > Notifications  – View

the list of unresolved notifications.

Modules > Production control > Inquir ies and repor ts > IoT Intelligence > Closed notificationsModules > Production control > Inquir ies and repor ts > IoT Intelligence > Closed notifications

– View the list of notifications that have been resolved or dismissed.

Modules > Production control > Inquir ies and repor ts > IoT Intelligence > Metr ic keysModules > Production control > Inquir ies and repor ts > IoT Intelligence > Metr ic keys  – View

the metric keys for the Resource StatusResource Status  times series charts.

Modules > Production control > Manufactur ing execution > Resource statusModules > Production control > Manufactur ing execution > Resource status  – Track specific

metrics by using the ConfigureConfigure dialog box. If a scenario detects an exception, a notification shows the details

of the exception.

Workspaces > Production floor management > NotificationsWorkspaces > Production floor management > Notifications  – View the list of unresolved

notifications.

When a scenario is running, you can make these changes:

Add new sensor schema definitions.

Select new signal data values.

Cancel the selection of existing signal data values.

Add and map new signal data values.

Update threshold values.

When a scenario is running, these changes are prohibited:

Delete or modify any schema definitions that are currently consumed by an enabled scenario.

Change the enabled scenario's selected schema paths.

You can simulate factory machine signals. For more information, see these topics:

Connect IoT DevKit AZ3166 to Azure IoT Hub

Connect Raspberry Pi online simulator to Azure IoT Hub (Node.js)

Device Simulation solution accelerator overview

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/iot/iot-management.md
https://docs.microsoft.com/en-us/azure/iot-hub/iot-hub-arduino-iot-devkit-az3166-get-started
https://docs.microsoft.com/en-us/azure/iot-hub/iot-hub-raspberry-pi-web-simulator-get-started
https://docs.microsoft.com/en-us/azure/iot-accelerators/iot-accelerators-device-simulation-overview
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Learning map

At its core, Master planning allows companies to determine and balance the future need for raw materials and

capacity to meet company goals. Master planning assesses the following:

What raw materials and capacities are currently available?

What raw materials and capacities are required to complete production? For example, what must be

manufactured, purchased, transferred, or set aside as safety stock before you can complete production.

Master planning uses the information to calculate the requirements and generate planned orders.

The three main planning processes are:

Master planningMaster planning - The Master plan calculates net requirements. It is based on actual current orders and

enables companies to control inventory replenishment on a short-term, day-to-day basis. Another term

to describe it is the Net requirements plan. For more information, see Master plans overview.

Forecast planningForecast planning - The Forecast schedule calculates gross requirements. It is based on future

projections (or forecasts), and enables companies to conduct long-term planning of materials and

capacity. For more information, see Demand forecasting overview.

Intercompany master planningIntercompany master planning - The Intercompany master plan calculates net requirements across

legal entities. It connects demand and supply between companies not only for short term, firm demand

and supply but also for long-term, planned (that is not yet firmed) demand and supply. For more

information, see Intercompany master planning (eLearning) (requires CustomerSource account).

Companies can change the output of the plan. They can run regenerative, net change, or both. Regenerative

plans update all requirements, whereas, net change plans only update the plan on items with new requirements

that have come in since the last scheduling run.

Master scheduling plans typically involve the short term, which can be anywhere from one week to six months.

The Master planning module determines the supply (materials) and capacity (resources) needs that will meet

current demand (the net requirements). In most companies this is extended to include the longest cumulative

lead time among the products to be received.

The following learning map shows the major concepts and tasks that make up the framework of the Master

planning module. Click the links in the Quick links section to learn how to use the module.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/master-planning-home-page.md
https://mbspartner.microsoft.com/AX/CourseOverview/1276


 Quick links

Additional resources
RoadmapsRoadmaps

BlogsBlogs

Task guidesTask guides

WebinarsWebinars

Tech conference recordingsTech conference recordings
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Master plans overview

Generate a constrained plan

Create a material plan for co-products

Master planning and multisite functionality overview

Create an intercompany plan

Demand forecasting overview

Forecast reduction keys

Go to the Microsoft Dynamics 365 Roadmap to see what new features have been released and what new

features are in development.

You can find opinions, news, and other information about Master planning and other solutions on the Dynamics

AX Manufacturing R&D Team blog and Supply Chain Management in Dynamics AX R&D Team blog.

Additional help is available as task guides. To access task guides, click the HelpHelp button on any page.

Use Azure machine learning for demand forecasting

Extend the demand forecasting functionality

Master planning - tips and tricks for troubleshooting performance

Help! MRP is slow!

Can you tell us about your documentation language preferences? Take a short survey.
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Obsolescence of the existing master planning engine

Migration, messages, and exceptions

New deploymentsNew deployments

Existing deploymentsExisting deployments

The built-in master planning engine is scheduled to be made obsolete (deprecated). It's being replaced by the

Planning Optimization Add-in for Microsoft Dynamics 365 Supply Chain Management. This topic provides

information about the impact on new and existing deployments. It includes information about required actions.

Planning Optimization enables master planning calculations to occur outside Supply Chain Management and its

Azure SQL database. The benefits that are associated with Planning Optimization include improved performance

and minimized impact on the SQL database during master planning runs. Because quick planning runs can be

done even during office hours, planners can immediately react to demand or parameter changes.

For more information about Planning Optimization, see Planning Optimization overview.

Microsoft is in the process of making the built-in planning engine obsolete in favor of Planning Optimization.

This change affects all cloud environments. On-premises installations aren't affected. In version 10.0.16 and later,

you will receive an error message if you run the built-in master planning without generating planned production

orders. However, the master planning run will be successfully completed despite the error message.

For more information about the obsolescence of the built-in planning engine, see the announcements in

Removed or deprecated features in Dynamics 365 Supply Chain Management.

Owners of existing environments who run the built-in master planning engine without generating planned

production orders will receive an email that provides details about the exception process. We recommend that

you work with a partner to evaluate and plan the migration to Planning Optimization.

As has been mentioned, you will receive an error message in version 10.0.16 and later if you run the built-in

master planning without generating planned production orders. This error message includes guidance about

migration and instructions for requesting an exception.

Planning Optimization should be considered the default master planning engine for all new deployments in the

cloud. In general, Planning Optimization should be used for all new deployments that don't generate planned

production orders during master planning. If a new deployment depends on functionality that Planning

Optimization doesn't currently support, you can request an exception so that you can continue to use the built-in

master planning engine.

Owners of existing cloud-based deployments that depend on master planning should plan to migrate to

Planning Optimization. If your implementation depends on functionality that Planning Optimization doesn't

currently support, you can request an exception so that you can continue to use the built-in master planning

engine.

For environments that currently use master planning processes that are being made obsolete, Microsoft will

send an email to the environment admin. This email will provide information about the actions that are required

to migrate or to request an exception.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/new-master-planning-engine.md


  

The exception process
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Frequently asked questions
Sandbox environmentsSandbox environments

-- Insert or update an enabled flight:
DECLARE @flightName NVARCHAR(100) = 'ReqPlanningOptimizationExceptionToggle';
IF NOT EXISTS (SELECT TOP 1 1 FROM SysFlighting WHERE flightName = @flightName)
    INSERT INTO SYSFLIGHTING(FLIGHTNAME,ENABLED, FLIGHTSERVICEID,PARTITION)
    SELECT @flightName, 1, 12719367,RECID FROM DBO.[PARTITIONS];
ELSE
    UPDATE SysFlighting SET enabled = 1, flightServiceId = 12719367 WHERE flightName = @flightName;

On-premises environmentsOn-premises environments

Production scenariosProduction scenarios

Email from MicrosoftEmail from Microsoft

You can request an exception if you must continue to use the built-in master planning engine because your

business processes depends heavily on at least one feature that isn't currently implemented in Planning

Optimization. For a list of available features, see Planning Optimization fit analysis.

Currently, exceptions for Planning Optimization migration are only relevant if your master planning process

doesn't include production (that is, planned production orders that are generated by master planning), and you

require the built-in master planning engine beyond version 10.0.15.

After the required features become available, Microsoft will provide a grace period until the exception expires.

The environment admin will be informed when the required features have become available and the grace

period has started.

You can only request an exception for production environments, not for sandbox environments. If you need to disable the

Planning Optimization exception error on an infrastructure as a service (IaaS) sandbox environment, run the SQL query

provided in Sandbox environments.

Can I use built-in master planning on my sandbox environment? Do I need an exception?

Answer :Answer : Exceptions aren't normally relevant for sandbox environments because the Planning Optimization

exception error doesn't prevent the built-in master planning engine from running successfully. However, if the

error message disturbs you, you can disable it on an IaaS (not Service Fabric) sandbox environment by running

the following query on your database:

My environment is on-premises. Do I need an exception?

Answer :Answer : No. An exception isn't required for on-premises environments. You can continue to use the built-in

master planning. Your environment admin will be informed if any action is required.

We use planned production orders, but I'm concerned about what will happen when we upgrade to version

10.0.16. Should I take any action?

Answer :Answer : You should not be concerned. You can continue to use the built-in master planning in version 10.0.16.

However, we recommend that you evaluate whether migration to Planning Optimization can start with the

current functionality. We also recommend that you remain informed about new functionality.

Our environment admin received an email from Microsoft. This email states that we should migrate to Planning

Optimization or request an exception. Do I need to take any action?



Error messagesError messages
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Answer :Answer : Yes. Your environment will be affected unless you follow the instructions in the email. You can either

migrate to Planning Optimization by the date specified or request an exception by using the link in the email.

This link opens a questionnaire. After you've completed and submitted this questionnaire, you will receive a

reply via email. Although this process is manual, Microsoft tries to reply within a week after the questionnaire is

submitted.

I'm using version 10.0.16 or later, and I receive the following error message when I run master planning. Is

master planning blocked?

You receive this error message because the built-in master planning engine was used for scenarios

supported by Planning Optimization. You should migrate to Planning Optimization now, as the current built-

in master planning will be deprecated. Note that this master planning run did complete successfully.

In case your migration has strong dependencies on pending features, an exception to continued usage of the

built-in master planning engine can be requested.

Please complete the following questionnaire to get started and if relevant request exception from migration

to Planning Optimization.

Answer :Answer : No, master planning isn't blocked. Your master planning run was successfully completed, and you can

use the result in the usual way. However, to avoid receiving this error message during future master planning

runs, you must either migrate to Planning Optimization immediately or request an exception by using the link in

the error message.
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Improved performance

Architecture and data flow

The Planning Optimization Add-in for Microsoft Dynamics 365 Supply Chain Management enables master

planning calculation to occur outside Dynamics 365 Supply Chain Management and the related SQL database.

The benefits that are associated with the Planning Optimization functionality include improved performance and

minimal impact on SQL database during master planning runs. Quick planning runs can be done even during

office hours, so that planners can immediately react to demand or parameter changes.

To use Planning Optimization, you must install the Planning Optimization Add-in from your project in Microsoft

Dynamics Lifecycle Services (LCS) and turn on the Planning Optimization functionality in Supply Chain

Management. For more information, see Get started with Planning Optimization.

The following illustration shows the advantage of running Planning Optimization during office hours.

Planning Optimization can be used in scenarios that involve long-running master plans. It's specifically designed

for very fast calculations that involve very large volumes of data. Because it's built as a hyper-scalable

multitenant service, multiple instances can work together simultaneously to calculate the plan. Additionally, the

planning service removes the load of master planning from your system and works with a data stream that

minimizes the server load.

Planning Optimization can help you achieve the following goals:

Improve planning performance through a shorter runtime.

Reduce the impact on other processes during the master planning run.

Do more frequent planning runs. (You aren't limited to daily runs.)

Be confident that future business growth won't overload the planning system.

When the Planning Optimization Add-in is installed from LCS, a secure connection to the Planning Optimization

service is established. The service is located in the same data center country or region as the related Supply

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/planning-optimization/planning-optimization-overview.md


High-level data flow for regeneration runsHigh-level data flow for regeneration runs

Related resources

NOTENOTE

Chain Management instance. After Planning Optimization is set up, when master planning is run, master data

and transactional data are sent from Supply Chain Management to the Planning Optimization service.

If the Planning Optimization Add-in is uninstalled, all related data in the Planning Optimization service is

removed.

1. The Supply Chain Management client sends a signal to request a planning run from Planning Optimization.

2. Planning Optimization requests the required data via the integrated connector.

3. The SQL database sends the requested information about setup, master, and transactional data to Planning

Optimization via the connector. The connector translates information between Supply Chain Management

and the Planning Optimization service.

4. The Planning Optimization service holds planning-related data in memory and does the required

calculations.

5. The planning result is sent to the Supply Chain Management database via the connector. The results include

information such as planned orders and pegging information. Planning Optimization sends a signal to

Supply Chain Management to indicate that the planning run has been completed. It also sends any relevant

messages and warnings.

The following illustration shows the data flow.

Get started with Planning Optimization

Planning Optimization fit analysis

View plan history and planning logs

Apply filters to a plan

Cancel a planning job

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Availability

Licensing

Install and enable Planning Optimization

As previously announced, Planning Optimization is scheduled to replace the existing built-in master planning

engine.

If you currently use the built-in master planning engine, you should start planning your migration to Planning

Optimization now. It is important to start the migration process right away because your operations may be

impacted when deprecation is enforced. To avoid last-minutes issues when deprecation is enforced, we strongly

encourage you to complete the migration before December 1, 2020.

The Planning Optimization functionality doesn't currently support all the features that are available in the

planning engine that is built into Supply Chain Management. Therefore, it's important that you evaluate whether

the feature set that is currently available in Planning Optimization will meet your requirements. The Planning

Optimization functionality isn't currently turned on by default in Dynamics Lifecycle Services (LCS), so you have

the opportunity to do your evaluation before the feature is turned on.

You need to request an exception from migration to Planning Optimization if your master planning process does not

include production (master planning generated planned production orders) and you require the built-in master planning

engine beyond version 10.0.15. Starting in version 10.0.16, an error will be shown in environments when running built-in

master planning without generation of planned production orders. Planning Optimization should be used for all new

deployments that do not generate planned production orders during master planning. Owners of existing environments

running the built-in master planning engine without generation of Planned production orders, will receive a mail with

details about the exception process. We recommend that you work with a partner to evaluate and plan the migration to

Planning Optimization.

Before you turn on Planning Optimization, we strongly recommend that you evaluate the results of the Planning

Optimization fit analysis. For more information, see Planning Optimization fit analysis.

Planning Optimization is currently available in the following Azure geographies: United States, Canada, Europe,

United Kingdom, Australia, and Asia Pacific. If you try to install the add-in from another geographic region, then

LCS will show a message that this geographic is not supported.

Note that Planning Optimization does not support on-premises deployments of Dynamics 365 Supply Chain

Management.

If you can run master planning by using your current license, you don't have to buy an additional license to start

to use Planning Optimization.

To use Planning Optimization, you must make sure your system has all of the prerequisites in place and then

enable its license key and install the Planning Optimization Add-in for Dynamics 365 Supply Chain

Management.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/planning-optimization/get-started.md
https://docs.microsoft.com/en-us/dynamics365/supply-chain/get-started/removed-deprecated-features-scm-updates#use-of-built-in-supply-chain-management-master-planning-engine-for-distribution-scenarios


PrerequisitesPrerequisites

Enable the Planning Optimization licenseEnable the Planning Optimization license

Install the Planning Optimization Add-inInstall the Planning Optimization Add-in

Integrate Planning Optimization with your system

Connection statusConnection status
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USED?USED?

Before you install the Planning Optimization Add-in, the following prerequisites must be in place:

You must be running Supply Chain Management on an LCS enabled high-availability environment, tier 2

or higher (not a OneBox environment), with Dynamics 365 Supply Chain Management version 10.0.7 or

later. If you try to install the add-in on a OneBox environment, the installation will not complete and you

will need to cancel the installation.

Your system must be set up for Power Platform integration. For more information, see Prerequisites for

setting up add-ins and Set up add-ins.

To use Planning Optimization, you must enable its configuration key. To do so:

1. Put your system into maintenance mode, as described in Maintenance mode.

2. Go to System administration > Setup > L icense configurationSystem administration > Setup > L icense configuration.

3. On the Configuration keysConfiguration keys  tab, select the check box for Planning OptimizationPlanning Optimization.

4. Turn off maintenance mode, as described in Maintenance mode.

You must install the add-in from your LCS project and then turn on the Planning Optimization functionality from

the Supply Chain Management user interface.

To install the Planning Optimization Add-in:

1. Sign in to LCS, and open the desired environment.

2. Go to Full detailsFull details .

3. Scroll down to the Environment add-insEnvironment add-ins  FastTab.

4. Select Install a new add-inInstall a new add-in .

5. Select Planning OptimizationPlanning Optimization.

6. Follow the installation guide, and agree to the terms and conditions.

7. Select InstallInstall .

8. On the Environment add-insEnvironment add-ins  FastTab, you should see that Planning Optimization is installing.

9. After a few minutes, InstallingInstalling should change to InstalledInstalled (you may need to refresh the page). When

installed, you are ready to activate Planning Optimization in Dynamics 365 Supply Chain Management.

The main purpose of installing the Planning Optimization Add-in is to connect the service and the environment.

Therefore, you must install the add-in separately on each environment where you will use Planning

Optimization, regardless of any code moved between the environments.

To configure whether the Planning Optimization Add-in should be used for master planning, go to MasterMaster

planningplanning > SetupSetup > Planning Optimization parametersPlanning Optimization parameters .

The connection status indicates the current status of the connection between Supply Chain Management and the

Planning Optimization service. The following table shows the possible values.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/power-platform/add-ins-overview
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/power-platform/add-ins-overview
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/sysadmin/maintenance-mode
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/sysadmin/maintenance-mode


Connected A connection has been established
between the Planning Optimization
service and Supply Chain
Management.

Yes

Enabling connection A request to turn on the connection to
the Planning Optimization service is
currently in progress.

No

Disconnected There is no connection to the Planning
Optimization service. The connection
can be turned on from LCS, as
described earlier in this topic.

No

Disabling connection A request to turn off the connection to
the Planning Optimization service is
currently in progress.

No

Getting status The system is waiting for status
information from the Planning
Optimization service.

No

C O N N EC T IO N  STAT USC O N N EC T IO N  STAT US DESC RIP T IO NDESC RIP T IO N
C A N  P L A N N IN G O P T IM IZ AT IO N  B EC A N  P L A N N IN G O P T IM IZ AT IO N  B E
USED?USED?

The Use Planning Optimization optionThe Use Planning Optimization option

NOTENOTE

Integration with the setupIntegration with the setup

Additional resources

The setting of the Use Planning OptimizationUse Planning Optimization option determines which planning engine is used for master

planning:

YesYes  – Planning Optimization is used for master planning.

NoNo – The built-in Supply Chain Management planning engine is used for master planning.

If existing planning batch jobs that were created for the built-in Supply Chain Management planning engine are triggered

while the Use Planning OptimizationUse Planning Optimization option is set to YesYes , those jobs will fail.

If the Planning Optimization is turned on, master planning is done by using the Planning Optimization Add-in. In

this case, master planning results and features are affected.

Terms and conditions for the preview

Planning Optimization overview

Planning Optimization fit analysis

View plan history and planning logs

Apply filters to a plan

Cancel a planning job

https://go.microsoft.com/fwlink/?linkid=2015274
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Analysis results: Example 1

Analysis results: Example 2

Overview of possible results from the fit analysis
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You should analyze the result from the Planning Optimization fit analysis as part of the migration process. Note

that the scope of Planning Optimization is not equal to the current built-in master planning functionality. We

recommend that you work with your partner and read the documentation to prepare for the migration.

Planning Optimization fit analysis helps you to identify where the result might differ between the built-in master

planning engine and Planning Optimization. This analysis is done based on your current setup and data.

To see the Planning Optimization fit analysis result, go to Master planningMaster planning > SetupSetup > PlanningPlanning

Optimization fit analysisOptimization fit analysis , and then select Run analysisRun analysis . If the analysis finds any inconsistencies, they are

listed on the same page. (The analysis can take a few minutes to run.)

If inconsistencies are found, you can still use Planning Optimization. The results of the fit analysis just show places where

the planning service won't honor your current setup. In other words, they show places where some processes might be

ignored or might not be supported.

Feature:Feature: Production

Issue:Issue: Items with a bill of materials (BOM) level greater than zero: 56

Explanation:Explanation: The fit analysis found 56 items that have a BOM setup for production. Because the current

version of Planning Optimization doesn't support production, Planning Optimization will generate planned

purchase orders instead of planned production orders. It will also show a warning that lists the affected

items.

Feature:Feature: Actions

Issue:Issue: Coverage groups with actions calculation enabled: 6

Explanation:Explanation: The fit analysis found six coverage groups where action calculation is turned on. Because the

current version of Planning Optimization doesn't support actions, no actions will be generated during master

planning.

The following table shows the various results that can be shown after a fit analysis. Number signs (#) will be

replaced with a number that indicates the number of records that have the listed issue. Supported or in-preview

features are available with version 10.0.9 or later (unless a higher version number is listed in the "Expected

availability" column).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/planning-optimization/planning-optimization-fit-analysis.md


Actions Coverage groups with
Actions calculation enabled:
#

This feature is pending.
Currently, actions aren't
generated during master
planning when Planning
Optimization is enabled,
regardless of this setting.
The main purpose of
actions is to suggest
changes to existing orders.
Evaluate if actions are
actively applied as part of
your business processes or
if the delay information
related to the orders is
sufficient.

October 2021

Base calendars Calendars using base
calendar: #

This feature is pending.
Currently, the base calendar
is ignored when Planning
Optimization is enabled.
Evaluate if the base
calendar is needed for your
business processes or if
direct setup in calendars is
sufficient.

April 2021

Batch disposition codes Non-nettable batch
disposition masters: #

This feature is pending.
Currently, batch disposition
codes are ignored when
Planning Optimization is
enabled.

October 2021

Capable to promise (CTP) Default order settings with
delivery date control set to
CTP: #

This feature is pending.
Currently, CTP is ignored
when Planning
Optimization is enabled,
regardless of this setting.

October 2021

Copy static to dynamic plan Copy of static to dynamic
plan is enabled on the
master planning
parameters.

Planning Optimization
doesn't copy the static plan
to the dynamic plan,
regardless of this setting. In
general, this concept is less
relevant because of the
speed and complete
regeneration that Planning
Optimization provides. If
two or more plans are used,
master planning should be
triggered for each plan.

October 2021
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Firming Coverage groups with auto
firming time fence set: #

In version 10.0.7 and later,
firming is supported as a
separate firming batch job
after master planning is
completed (provided the
Auto-firming for Planning
Optimization feature has
been enabled in feature
management). Note that
auto firming for Planning
Optimization is based on
the order date (start date),
not the requirement date
(end date). This behavior
ensures that firming of
planned orders occurs in
due time, without having to
include lead time in the
firming time fence.

Supported

Firming Item coverage records with
auto firming set: #

In version 10.0.7 and later,
auto firming is supported
as a separate firming batch
job after master planning is
completed (provided the
Auto-firming for Planning
Optimization feature has
been enabled in feature
management). Note that
auto firming for Planning
Optimization is based on
the order date (start date),
not the requirement date
(end date). This behavior
ensures that firming of
planned orders occurs in
due time, without having to
include lead time in the
firming time fence.

Supported

Firming Master plans with auto
firming set: #

In version 10.0.7 and later,
auto firming is supported
as a separate firming batch
job after master planning is
completed (provided the
Auto-firming for Planning
Optimization feature has
been enabled in feature
management). Note that
auto firming for Planning
Optimization is based on
the order date (start date),
not the requirement date
(end date). This behavior
ensures that firming of
planned orders occurs in
due time, without having to
include lead time in the
firming time fence.

Supported
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FitAnalysisPlanningItems Planning Items: # This feature is pending.
Currently, planning items
are handled like regular
items when Planning
Optimization is enabled.

October 2021

Forecast Coverage groups with
"Include intercompany
orders" enabled: #

This feature is pending.
Currently, master planning
doesn't include downstream
planned demand when
Planning Optimization is
enabled, regardless of this
setting. Note that
released/firmed orders still
work with the regular
intercompany functionality
and will cover most
scenarios.

In preview

Forecast Coverage groups with
"Reduce forecast by" setting
set to a value different than
"Orders": #

By default, Planning
Optimization uses "Reduce
forecast by" for orders,
regardless of this setting.

Supported

Forecast Forecast models with sub
models: #

This feature is pending.
Currently, forecasts that use
sub-models aren't
supported when Planning
Optimization is enabled.
They will be ignored,
regardless of this setting.

April 2021

Forecast Master plans with "Include
supply forecast" enabled: #

This feature is pending.
Currently, supply forecasts
aren't supported when
Planning Optimization is
enabled. They will be
ignored, regardless of this
setting.

October 2021

Freeze time fence Coverage groups with
freeze time fence set: #

The freeze time fence isn't
often used, and there are
currently no plans to
include it for Planning
Optimization. Currently, the
freeze time fence setup is
ignored when Planning
Optimization is enabled,
regardless of this setting.

N/A

Freeze time fence Item coverage records with
freeze time fence set: #

The freeze time fence isn't
often used, and there are
currently no plans to
include it for Planning
Optimization. Currently, the
freeze time fence setup is
ignored when Planning
Optimization is enabled,
regardless of this setting.

N/A

F EAT UREF EAT URE L IST ED ISSUEL IST ED ISSUE EXP L A N AT IO NEXP L A N AT IO N EXP EC T ED AVA IL A B IL IT YEXP EC T ED AVA IL A B IL IT Y



Freeze time fence Master plans with freeze
time fence set: #

The freeze time fence isn't
often used, and there are
currently no plans to
include it for Planning
Optimization. Currently, the
freeze time fence setup is
ignored when Planning
Optimization is enabled,
regardless of this setting.

N/A

Intercompany Master plans including
planned downstream
demand: #

This feature is pending.
Currently, master planning
doesn't include downstream
planned demand when
Planning Optimization is
enabled, regardless of this
setting. Note that
released/firmed orders still
work with the normal
intercompany functionality
and will cover most
scenarios.

In preview

Kanban Item coverage records with
planned order type kanban:
#

This feature is pending.
Currently, item coverage
that is set to kanban will be
ignored when Planning
Optimization is enabled.
The kanban planned order
type will create a warning
during master planning,
and planned purchase
orders will be created to
cover the related demand.

October 2021

Kanban Items with default order
type kanban: #

Currently, a default order
type that is set to kanban
will be ignored when
Planning Optimization is
enabled. The kanban default
order type will create a
warning during master
planning, and planned
purchase orders will be
created to cover the related
demand.

October 2021

Product lifecycle state Product lifecycle states not
active for planning: #

This is a pending feature.
Currently the Product
lifecycle state is ignored
with Planning Optimization
enabled. You can adjust the
plan level product filter to
avoid including products
where product lifecycle
state is disabled for
planning.

Supported
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Production BOM lines with rounding or
multiple setup: #

This feature is pending.
Currently, rounding and
multiple setups are ignored
on BOM lines when
Planning Optimization is
enabled, regardless of this
setting.

April 2021

Production BOM/formula lines with
formula measurement: #

This feature is pending.
Currently, formula
measurement is ignored on
BOM and formula lines
when Planning
Optimization is enabled,
regardless of this setting.

October 2021

Production BOM/formula lines with
item substitution (plan
groups): #

This feature is pending.
Currently, item substitution
(plan groups) is ignored on
BOM and formula lines
when Planning
Optimization is enabled,
regardless of this setting.

October 2021

Production BOM/formula lines with
negative quantity: #

This feature is pending.
BOM and formula lines that
have negative quantity will
be included with a quantity
of 0 (zero) and a warning
will be issued when
Planning Optimization is
enabled. Update master
data to avoid warnings.

October 2021

Production BOM/formula lines with
resource consumption: #

This feature is pending.
Currently, BOM and
formula lines that have
resource consumption are
ignored when Planning
Optimization is enabled.
When this feature is
supported, the material
requirement will be set to
the production start date.
Until this feature is
supported, requirements
will not be generated for
materials that are marked
with a resource
consumption flag.

April 2021

Production BOM/formula lines with
step consumption: #

This feature is pending.
Currently, step
consumption is ignored on
BOM and formula lines
when Planning
Optimization is enabled.

October 2021
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Production BOMs with constant scrap
or variable scrap defined: #

This feature is pending.
Currently, constant scrap
and variable scrap that are
defined on BOMs are
ignored when Planning
Optimization is enabled.

October 2021

Production BOMs with subcontracting:
#

This feature is pending.
Currently, the
subcontracting setup on
BOMs is ignored when
Planning Optimization is
enabled, regardless of this
setting.

October 2021

Production BOMs without a site: # This feature is pending.
Currently, BOMs without a
site are ignored when
Planning Optimization is
enabled.

Supported

Production Demand with specific BOM
or route requirements
defined: #

This feature is pending.
Currently, the specific BOM
or route requirements that
are defined on the demand
(such as a sub-BOM or
sub-route on a sales order)
are ignored when Planning
Optimization is enabled.
The standard BOM or route
will be used, regardless of
this setting.

October 2021

Production Formula versions with
Co/By products: #

This feature is pending.
Currently, co-products and
by-products that are
associated with the formula
version are ignored when
Planning Optimization is
enabled.

October 2021

Production Formula versions with Yield:
#

This feature is pending.
Currently, yield that is
associated with the formula
version is ignored when
Planning Optimization is
enabled.

October 2021

Production Plans including sequencing:
#

This feature is pending.
Currently, sequencing is
ignored when Planning
Optimization is enabled,
regardless of this setting.

October 2021
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Production Released production orders
that are not started, where
scheduled start is earlier
than today: #

This feature is pending.
Currently, if a production
order is delayed, then
master planning will assume
that it will be completed
today. This is relevant for
released production orders
where a delivery date is in
the past, but it has not
been completed yet.

October 2021

Production Resources scheduled with
finite capacity: #

This feature is pending.
Currently, resources that
are scheduled with finite
capacity are ignored when
Planning Optimization is
enabled. Scheduling is done
based on the default lead
time from the product.

April 2021

Production Routes used in planning: # This feature is pending.
Currently, routes are
ignored when Planning
Optimization is enabled.
The default lead time from
the product is used.

April 2021

Production Sales line reservation using
explosion: #

Sales line reservation that
uses explosion isn't
supported when Planning
Optimization is enabled.

October 2021

Production Scheduling with explosion
of production orders: #

Scheduling that uses
explosion of production
orders isn't supported when
Planning Optimization is
enabled. Production orders
can be scheduled
individually.

October 2021

Request for quotations Master plans with request
for quotations enabled: #

This feature is pending.
Currently, requests for
quotation (RFQs) aren't
considered as demand
when Planning
Optimization is enabled.
They will be ignored,
regardless of this setting.

October 2021

Requisitions Master plans with
requisitions enabled: #

This feature is pending.
Currently, requisitions aren't
considered when Planning
Optimization is enabled.
They will be ignored,
regardless of this setting.

October 2021
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Safety margins Coverage groups with
safety margin: #

This feature is pending.
Currently, safety margin is
ignored when Planning
Optimization is enabled. To
compensate for this
behavior, you can increase
the lead time so that it
includes the safety margin.

Receipt margin: Supported.
Reorder margin and issue
margin: April 2021

Safety margins Master plans with safety
margin: #

This feature is pending.
Currently, safety margin is
ignored when Planning
Optimization is enabled,
regardless of this setting. To
compensate for this
behavior, you can increase
the lead time so that it
includes the safety margin.

Receipt margin: Supported.
Reorder margin and issue
margin: April 2021

Safety stock fulfillment Item coverage records with
"Fulfill minimum" different
from "Today's date +
procurement time": #

Planning Optimization
always uses Today's date +
procurement time. This
change is made to prepare
for a simplified planning
setup in the future, and to
provide an actionable result.
If the procurement time
isn't included for safety
stock, planned orders that
are created for current low
on-hand inventory will
always be delayed because
of the lead time. This
behavior can cause
significant noise and
unwanted planned orders.
The best practice is to
change the setting so that
Today's date + procurement
time is used. Update master
data to avoid warnings.

N/A

Sales quotations Master plans with sales
quotations enabled: #

This feature is pending.
Currently, quotations aren't
considered when Planning
Optimization is enabled.
They will be ignored,
regardless of this setting.

October 2021

Shelf life Master plans with shelf life
enabled: #

This feature is pending.
Currently, shelf life isn't
considered when Planning
Optimization is enabled,
regardless of this setting.

October 2021
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Additional resources
Planning Optimization overview
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Example scenario
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Related resources
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When the Planning Optimization functionality is used, you can apply a filter to a plan. The Plan filterPlan filter  will always

be applied during a master planning run. A Plan filterPlan filter  is useful when you want to limit a plan to a specific

group of items and make sure that no other items are included as part of the resulting master planning.

If a Plan filterPlan filter  is applied, and a runtime filter is also applied during the master planning run, only the

intersection of the two filters is included in the planning run.

The Plan filterPlan filter  can be accessed from Master plansMaster plans  when Planning Optimization is used.

A plan filter is set up that includes items A, B, and C. Master planning runs are then run for the same plan, but

different runtime filters are applied:

Runtime filter  that includes item D:Runtime filter  that includes item D: No items are planned, because there is no intersection between the

plan filter and the runtime filter.

Runtime filter  that includes item A and D:Runtime filter  that includes item A and D: Only item A is included in the planning run, because item D

isn't part of the plan filter.

Runtime filter  that includes item B:Runtime filter  that includes item B: Only item B is included in the planning run, and the previous

planning output for item A is kept.

Runtime filter  that includes all items (blank filter):Runtime filter  that includes all items (blank filter): Items A, B, and C are included in the planning run,

and the previous planning output for items A and B is overwritten.

You should avoid setting a plan filter on the plan that is selected as Current dynamic master planCurrent dynamic master plan on the MasterMaster

planning parametersplanning parameters  page. Otherwise, the dynamic master plan functionality will be limited to the filtered items. For

example, if the net requirements are updated for an item that isn't part of the plan filter, no result will be generated.

Planning Optimization overview

Get started with Planning Optimization

Planning Optimization fit analysis

View plan history and planning logs

Cancel a planning job

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/planning-optimization/plan-filters.md
https://aka.ms/BAG_Docs_Language_Survey
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NOTENOTE

Set up a master plan to include a demand forecast

Set up a coverage group to include a demand forecast

You can use a demand forecast together with Planning Optimization to account for expected demand in your

master planning. You can manually create a demand forecast, import it, or generate it by using the demand

forecasting functionality in Microsoft Dynamics 365 Supply Chain Management. For more information about

demand forecasting, see Demand forecasting overview.

Separate forecast planning isn't supported with Planning Optimization. Therefore, the Current forecast planCurrent forecast plan setting on

the Master planning parametersMaster planning parameters  page has no effect when you use Planning Optimization.

To configure a master plan so that it includes a demand forecast, follow these steps.

IMPORTANTIMPORTANT

1. Go to Master planning > Setup > Plans > Master plansMaster planning > Setup > Plans > Master plans .

2. Select an existing plan, or create a new plan.

3. On the GeneralGeneral  FastTab, set the following fields:

Forecast modelForecast model  – Select the forecast model to apply. This model will be considered when a supply

suggestion is generated for the current master plan.

Include demand forecastInclude demand forecast – Set this option to Yes to include the demand forecast in the current

master plan. If you set it to No, demand forecast transactions won't be included in the master plan.

Method used to reduce forecast requirementsMethod used to reduce forecast requirements  – Select the method that should be used to

reduce forecast requirements. For more information, see the Forecast reduction keys section later in

this topic.

4. On the Time fence in daysTime fence in days  FastTab, you can set the following fields to specify the period that the

demand forecast is included during:

Forecast planForecast plan – Set this option to Yes to override the forecast plan time fence that originates from

the individual coverage groups. Set it to No to use the values from the individual coverage groups for

the current master plan.

Forecast time periodForecast time period – If you set the Forecast planForecast plan option to Yes, specify the number of days (from

today's date) that the demand forecast should be applied.

The Forecast planForecast plan setting isn't yet supported with Planning Optimization.

To configure a coverage group so that it includes a demand forecast, follow these steps.

1. Go to Master planning > Setup > Plans > Coverage groupsMaster planning > Setup > Plans > Coverage groups .

2. Select an existing coverage group, or create a new group.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/planning-optimization/demand-forecast.md


 Forecast reduction keys

Methods that are used to reduce forecast requirementsMethods that are used to reduce forecast requirements

3. On the OtherOther  FastTab, set the following fields:

NOTENOTE

Forecast plan time fenceForecast plan time fence – Enter the number of days (from today's date) that the demand

forecast should be applied for. This value can be overridden by using the Forecast planForecast plan option on

the master plan, as described in the previous section.

Reduction keyReduction key  – Select the reduction key to apply. For more information, see the Create and set

up a forecast reduction key and Use a reduction key sections later in this topic.

Reduce forecast byReduce forecast by  – For master plans where the Method used to reduce forecastMethod used to reduce forecast

requirementsrequirements  field is set to Transactions - reduction key or Transactions - dynamic period, specify

which transactions should reduce the forecast. Select one of the following values:

All transactionsAll transactions  – All transactions should reduce the forecast.

OrdersOrders  – Only sales orders should reduce the forecast.

If you select All transactions, transactions that have both demand and supply in the same inventory

dimensions are considered neutral and are ignored during the forecast reduction. For example, if the

planning dimension is set to site only, not warehouse, a transfer order between site 1, warehouse 11, and

site 1, warehouse 13, will be ignored and won't reduce the remaining demand forecast.

Include intercompany ordersInclude intercompany orders  – Set this option to Yes if intercompany orders should be

included when the forecast is reduced. Otherwise, set it to No.

Include customer forecast in the demand forecastInclude customer forecast in the demand forecast – Specify whether a customer forecast

should be included in the overall forecast. This option determines how actual demand reduces the

forecasted demand. You can use it to ensure that master planning covers the supply of items that

are purchased by specific customers.

Set this option to Yes to include a customer forecast in the overall forecast. In this case, actual

customer demand reduces both the customer forecast and the overall forecast. Master

planning generates planned orders to cover only the overall forecast quantity.

Set this option to No if you don't want to include a customer forecast in the overall forecast. In

this case, actual customer demand reduces only the customer forecast. Master planning

generates planned orders to cover both the overall forecast quantity and the forecast for each

customer quantity.

This section provides information about the different methods that are used to reduce forecast requirements. It

includes examples of the results of each method. It also explains how to create, set up, and use a forecast

reduction key. Some methods use a forecast reduction key to reduce forecast requirements.

When you include a forecast in a master plan, you can select how the forecast requirements are reduced when

actual demand is included. Note that master planning excludes forecast requirements from the past, which

means all forecast requirements before today's date.

To include a forecast in a master plan and select the method that is used to reduce forecast requirements, go to

Master planning > Setup > Plans > Master plansMaster planning > Setup > Plans > Master plans . In the Forecast modelForecast model  field, select a forecast model. In

the Method used to reduce forecast requirementsMethod used to reduce forecast requirements  field, select a method. The following options are

available:

None



NoneNone

Percent – reduction keyPercent – reduction key

Ex a m p l e : P e r c e n t  –  r e d u c t i o n  k e yEx a m p l e : P e r c e n t  –  r e d u c t i o n  k e y

M O N T HM O N T H DEM A N D F O REC A STDEM A N D F O REC A ST

January 1,000

February 1,000

March 1,000

April 1,000

C H A N GEC H A N GE UN ITUN IT P ERC EN TP ERC EN T

1 Month 100

2 Month 75

3 Month 50

4 Month 25

Percent – reduction key

Transactions – reduction key (not yet supported with Planning Optimization)

Transactions – dynamic period

The following sections provide more information about each option.

If you select NoneNone, the forecast requirements aren't reduced during master scheduling. In this case, master

planning creates planned orders to supply the forecasted demand (forecast requirements). These planned

orders maintain the suggested quantity, regardless of other types of demand. For example, if sales orders are

placed, master planning creates additional planned orders to supply the sales orders. The quantity of the

forecast requirements isn't reduced.

If you select Percent - reduction keyPercent - reduction key , the forecast requirements are reduced according to the percentages and

periods that are defined by the reduction key. In this case, master planning creates planned orders where the

quantity is calculated as forecasted quantity × reduction key in each period. If there are other types of demand,

master planning also creates planned orders to supply that demand.

This example shows how a reduction key reduces demand forecast requirements according to the percentages

and periods that are defined by the reduction key.

For this example, you include the following demand forecast in a master plan.

On the Reduction keysReduction keys  page, you set up the following lines.

You assign the reduction key to the item's coverage group. Then, on the Master plansMaster plans  page, in the MethodMethod

used to reduce forecast requirementsused to reduce forecast requirements  field, you select Percent - reduction keyPercent - reduction key .

In this case, if you run forecast scheduling on January 1, the demand forecast requirements are consumed

according to the percentages that you set up on the Reduction keysReduction keys  page. The following requirement

quantities are transferred to the master plan.



M O N T HM O N T H P L A N N ED O RDER Q UA N T IT YP L A N N ED O RDER Q UA N T IT Y C A L C UL AT IO NC A L C UL AT IO N

January 0 = 0% × 1,000

February 250 = 25% × 1,000

March 500 = 50% × 1,000

April 750 = 75% × 1,000

May through December 1,000 = 100% × 1,000

Transactions – reduction keyTransactions – reduction key

Ex a m p l e : T r a n sa c t i o n s  –  r e d u c t i o n  k e yEx a m p l e : T r a n sa c t i o n s  –  r e d u c t i o n  k e y

M O N T HM O N T H N UM B ER O F  P IEC ES O RDEREDN UM B ER O F  P IEC ES O RDERED

January 956

February 1,176

March 451

April 119

M O N T HM O N T H N UM B ER O F  P IEC ES REQ UIREDN UM B ER O F  P IEC ES REQ UIRED

January 44

February 0

March 549

April 881

May through December 1,000

Transactions – dynamic periodTransactions – dynamic period

If you select Transactions - reduction keyTransactions - reduction key , the forecast requirements are reduced by the transactions that

occur during the periods that are defined by the reduction key.

This example shows how actual orders that occur during the periods that are defined by the reduction key

reduce demand forecast requirements.

For this example, you select Transactions - reduction keyTransactions - reduction key  in the Method used to reduce forecastMethod used to reduce forecast

requirementsrequirements  field on the Master plansMaster plans  page.

The following sales orders exist on January 1.

If you use the same demand forecast of 1,000 pieces per month that was used in the previous example, the

following requirement quantities are transferred to the master plan.

If you select Transactions - dynamic periodTransactions - dynamic period, the forecast requirements are reduced by the actual order

transactions that occur during the dynamic period. The dynamic period covers the current forecast dates and

ends at the start of the next forecast. In this case, master planning creates planned orders to supply the

forecasted demand (forecast requirements). However, when actual order transactions are placed, the forecast



Ex a m p l e  1 :  T r a n sa c t i o n s  –  d y n a m i c  p e r i o dEx a m p l e  1 :  T r a n sa c t i o n s  –  d y n a m i c  p e r i o d

DAT EDAT E DEM A N D F O REC A STDEM A N D F O REC A ST

January 1 1,000

February 1 1,000

DAT EDAT E SA L ES O RDER Q UA N T IT YSA L ES O RDER Q UA N T IT Y

January 15 200

February 15 400

DEM A N D F O REC A ST  DAT EDEM A N D F O REC A ST  DAT E Q UA N T IT YQ UA N T IT Y EXP L A N AT IO NEXP L A N AT IO N

January 1 800 Forecast requirements (= 1,000 – 200)

January 15 200 Sales orders requirements

February 1 600 Forecast requirements (= 1,000 – 400)

February 15 400 Sales orders requirements

Ex a m p l e  2 : T r a n sa c t i o n s  –  d y n a m i c  p e r i o dEx a m p l e  2 : T r a n sa c t i o n s  –  d y n a m i c  p e r i o d

DAT EDAT E DEM A N D F O REC A STDEM A N D F O REC A ST

January 1 1,000

January 5 500

requirements are reduced. The actual transactions consume part of the forecasted requirements.

When this option is used, the following behavior occurs:

Reduction keys aren't required or used.

If the forecast is completely reduced, the forecast requirements for the current forecast become 0 (zero).

If there is no future forecast, forecast requirements from the last forecast that was entered are reduced.

Time fences are included in the forecast reduction calculation.

Positive days are included in the forecast reduction calculation.

If actual order transactions exceed the forecasted requirements, the remaining transactions aren't forwarded

to the next forecast period.

Here a simple example that shows how the Transactions - dynamic periodTransactions - dynamic period method works.

For this example, you include the following demand forecast in a master plan.

You also create the following sales orders.

In this case, the following planned orders are created.

In most cases, systems are set up so that transactions reduce demand forecast in specific forecast periods:

weeks, months, and so on. These periods are defined in the reduction key. However, the time between two

demand forecast lines can also imply a period.

For this example, you create a demand forecast for the following dates and quantities.



  

January 12 1,000

DAT EDAT E DEM A N D F O REC A STDEM A N D F O REC A ST

DAT EDAT E SA L ES O RDER Q UA N T IT YSA L ES O RDER Q UA N T IT Y

December 15 in the previous year 500

January 3 100

January 10 200

DEM A N D F O REC A ST  DAT EDEM A N D F O REC A ST  DAT E Q UA N T IT YQ UA N T IT Y EXP L A N AT IO NEXP L A N AT IO N

December 15 in the previous year 500 Sales order requirements

January 1 900 Forecast requirements period January
1 to January 5 (= 1,000 – 100)

January 3 100 Sales order requirements

January 5 300 Forecast requirements period January
5 to January 10 (= 500 – 200)

January 12 1,000 Forecast requirements period January
12 to end

Create and set up a forecast reduction keyCreate and set up a forecast reduction key

Notice that, in this forecast, there isn't a clear period between the forecast dates. Between the first and second

dates there is a four-day span, and between the second and third dates there is a seven-day span. These spans

are the dynamic periods.

You also create the following sales order lines.

In this case, the forecast is reduced in the following manner :

Because the first sales order isn't in any period, it doesn't reduce any forecast.

Because the second sales order is between January 1 and January 5, it reduces the forecast for January 1 by

100.

Because the third sales order is between January 5 and January 12, it reduces the forecast for January 5 by

200.

Therefore, the following planned orders are created.

A forecast reduction key is used in the Transactions - reduction keyTransactions - reduction key  and Percent- reduction keyPercent- reduction key  methods

for reducing forecast requirements. Follow these steps to create and set up a reduction key.

1. Go to Master planning > Setup > Coverage > Reduction keysMaster planning > Setup > Coverage > Reduction keys .

2. Select NewNew  to create a reduction key.

3. In the Reduction keyReduction key  field, enter a unique identifier for the forecast reduction key. Then, in the NameName

field, enter a name.

4. Define the periods and the reduction key percentage in each period:



  Use a reduction keyUse a reduction key

Reduce a forecast by transactionsReduce a forecast by transactions

Forecast models and submodels

Submodel levelsSubmodel levels

The Effective dateEffective date field indicates the date when creation of the periods starts. When the Use theUse the

effective dateeffective date option is set to YesYes , the periods start on the effective date. When it's set to NoNo, the

periods start on the date when master planning is run.

Define the periods that the forecast reduction should occur during.

For a specific period, specify the percentages that the forecast requirements should be reduced by. You

can enter positive values to decrease requirements or negative values to increase requirements.

A forecast reduction key must be assigned to the coverage group of the item. Follow these steps to assign a

reduction key to an item's coverage group.

1. Go to Master planning > Setup > Coverage > Coverage groupsMaster planning > Setup > Coverage > Coverage groups .

2. On the OtherOther  FastTab, in the Reduction keyReduction key  field, select the reduction key to assign to the coverage

group. The reduction key then applies to all items that belong to the coverage group.

3. To use a reduction key to calculate forecast reduction during master scheduling, you must define this

setting in the setup of the forecast plan or the master plan. Go to one of the following locations:

Master planning > Setup > Plans > Forecast plansMaster planning > Setup > Plans > Forecast plans

Master planning > Setup > Plans > Master plansMaster planning > Setup > Plans > Master plans

4. On the Forecast plansForecast plans  or Master plansMaster plans  page, on the GeneralGeneral  FastTab, in the Method used to reduceMethod used to reduce

forecast requirementsforecast requirements  field, select either Percent - reduction keyPercent - reduction key  or Transactions - reductionTransactions - reduction

keykey .

When you select Transactions - reduction keyTransactions - reduction key  or Transactions - dynamic periodTransactions - dynamic period as the method for

reducing forecast requirements, you can specify which transactions reduce the forecast. On the CoverageCoverage

groupsgroups  page, on the OtherOther  FastTab, in the Reduce forecast byReduce forecast by  field, select All transactionsAll transactions  if all transactions

should reduce the forecast or OrdersOrders  if only sales orders should reduce the forecast.

This section describes how to create forecast models and how to combine multiple forecast models by setting

up submodels.

A forecast model names and identifies a specific forecast. After you've created the forecast model, you can add

forecast lines to it. To add forecast lines for multiple items, use the Demand forecast linesDemand forecast lines  page. To add

forecast lines for a specific selected item, use the Released productsReleased products  page.

A forecast model can include forecasts from other forecast models. To achieve this result, you add other forecast

models as submodels of a parent forecast model. You must create each relevant model before you can add it as

a submodel of a parent forecast model.

The resulting structure gives you a powerful way to control forecasts, because it lets you combine (aggregate)

the input from multiple individual forecasts. Therefore, from a planning point of view, it's easy to combine

forecasts for simulations. For example, you might set up a simulation that is based on the combination of a

regular forecast with the forecast for a spring promotion.

There is no limit on the number of submodels that can be added to a parent forecast model. However, the

structure can be only one level deep. In other words, a forecast model that is a submodel of another forecast

model can't have its own submodels. When you add submodels to a forecast model, the system checks whether

that forecast model is already a submodel of another forecast model.

If master planning encounters a submodel that has its own submodels, you receive an error message.



Submodel levels exampleSubmodel levels example

Aggregating forecasts across forecast modelsAggregating forecasts across forecast models

Aggregation exampleAggregation example

NOTENOTE

Create a forecast modelCreate a forecast model

Assign submodels to a forecast modelAssign submodels to a forecast model

Forecast model A has forecast model B as a submodel. Therefore, forecast model B can't have its own

submodels. If you try to add a submodel to forecast model B, you receive the following error message: "Forecast

model B is a submodel for model A."

Forecast lines that occur on the same day will be aggregated across their forecast model and its submodels.

Forecast model A has forecast models B and C as submodels.

Forecast model A includes a demand forecast for 2 pieces (pcs) on June 15.

Forecast model B includes a demand forecast for 3 pcs on June 15.

Forecast model C includes a demand forecast for 4 pcs on June 15.

The resulting demand forecast will be a single demand for 9 pcs (2 + 3 + 4) on June 15.

Each submodel uses its own parameters, not the parameters of the parent forecast model.

To create a forecast model, follow these steps.

NOTENOTE

1. Go to Master planning > Setup > Demand forecasting > Forecast modelsMaster planning > Setup > Demand forecasting > Forecast models .

2. On the Action Pane, select NewNew .

3. Set the following fields for the new forecast model:

ModelModel  – Enter a unique identifier for the model.

NameName – Enter a descriptive name for the model.

StoppedStopped – Usually, you should set this option to No. Set it to Yes only if you want to prevent editing of

all forecast lines that are assigned to the model.

The Include in cash flow forecastsInclude in cash flow forecasts  field and the fields on the ProjectProject  FastTab aren't related to master

planning. Therefore, you can ignore them in this context. You must consider them only when you work with

forecasts for the Project management and accountingProject management and accounting module.

To assign submodels to a forecast model, follow these steps.

1. Go to Inventor y management > Setup > Forecast > Forecast modelsInventor y management > Setup > Forecast > Forecast models .

2. In the list pane, select the forecast model to set up a submodel for.

3. On the SubmodelSubmodel  FastTab, select AddAdd to add a row to the grid.

4. In the new row, set the following fields:

SubmodelSubmodel  – Select the forecast model to add as a submodel. This forecast model must already exist,

and it must not have any submodels of its own.

NameName – Enter a descriptive name for the submodel. For example, this name might indicate the

submodel's relation to the parent forecast model.
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Turn on the Purchase trade agreements for Planning Optimization
feature

Prepare your system to evaluate purchase trade agreements during
master planning

Prepare a released product to evaluate purchase trade agreements
during master planning

This topic describes how Planning Optimization can find the vendor and/or lead time for a planned order, based

on the best price or lead time that is found among all purchase trade agreements that have been specified for a

given product.

Before you can use this feature, it must be turned on in your system. Admins can use the Feature management

workspace to check the status of the feature and turn it on if it's required. There, the feature is listed in the

following way:

Module:Module: Master planning

Feature name:Feature name: Purchase trade agreements for Planning Optimization

Follow these steps to configure your system to apply Planning Optimization that evaluates purchase trade

agreements.

1. Go to Master planning > Setup > Master planning parametersMaster planning > Setup > Master planning parameters . On the Planned ordersPlanned orders  tab, in

the VendorVendor  section, set the following values:

Find trade agreementFind trade agreement – Set this option to YesYes  to include purchase trade agreements in master

planning.

Search cr iter ionSearch cr iter ion – Select the factor that you want to prioritize for each purchase trade agreement:

Minimum lead timeMinimum lead time or Lowest unit pr iceLowest unit pr ice.

2. Go to Procurement and sourcing > Setup > Pr ices and discounts > Activate pr ice/discountProcurement and sourcing > Setup > Pr ices and discounts > Activate pr ice/discount,

and make sure that the VendorVendor  option is set to YesYes .

3. Go to Product information management > Setup > Dimension and var iant groups > StorageProduct information management > Setup > Dimension and var iant groups > Storage

dimension groupsdimension groups , and select a storage dimension group that applies to products that master planning

should evaluate purchase trade agreements for. Make sure that each relevant storage dimension in this

group has a check mark in the For purchase pr icesFor purchase pr ices  column. Repeat this step for every other relevant

storage dimension group.

After your system is prepared as described in the previous section, you should follow these steps to make sure

that each product that you want to use with this feature is correctly set up.

1. Go to Product information management > Products > Released productsProduct information management > Products > Released products , and open a target

product.

2. On the PurchasePurchase FastTab, make sure that no vendor is assigned in the VendorVendor  field.

3. On the Action Pane, on the PlanPlan tab, in the CoverageCoverage group, select Item coverageItem coverage to open the ItemItem

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/planning-optimization/purchase-trade-agreement.md
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Examples of how Planning Optimization finds vendor and lead times
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coveragecoverage page for the selected product. Verify the following settings:

On the GeneralGeneral  tab, you can set up vendor overrides. If you want Planning Optimization to use

purchase trade agreements to select a vendor, you should prevent vendor overrides by clearing the

Use specific settingUse specific setting check box.

On the Lead timeLead time tab, you can set up lead-time overrides. If you want Planning Optimization to use

purchase trade agreements to select lead times, you should prevent lead-time overrides. Clear the

check box for each type of lead time that you want to select by using purchase trade agreements

(PurchasePurchase, ProductionProduction, and/or TransferTransfer ).

4. Close the Item coverageItem coverage page to return to the details page for the selected product.

5. On the Action Pane, on the PlanPlan tab, in the ForecastForecast group, select Supply forecastSupply forecast to open the SupplySupply

forecastforecast page. Make sure that no row that is shown here has a value in the Vendor accountVendor account column.

6. Close the Supply forecastSupply forecast page to return to the details page for the selected product.

7. On the Action Pane, on the PurchasePurchase tab, in the Trade agreementsTrade agreements  group, select View tradeView trade

agreementsagreements . Make sure that all the relevant purchase trade agreements are listed. Also make sure that

the Disregard lead timeDisregard lead time option is set to NoNo for each agreement where you want Planning Optimization

to use the lead time that is specified for that agreement.

8. On the Action Pane, on the PlanPlan tab, in the Order settingsOrder settings  group, select Default order settingsDefault order settings  to

open the Default order settingsDefault order settings  page for the selected product. On the Purchase orderPurchase order  FastTab, view

the value of the Purchase lead timePurchase lead time field. If no item coverage lead-time override is defined, Planning

Optimization will use this value when it selects trade agreements where the Disregard lead timeDisregard lead time option

is set to YesYes . Therefore, you should adjust this value as you require.

9. Repeat this procedure for each relevant product.

Currency on the purchase trade agreement line must match the currency of the selected vendor. Master planning will only

include information from purchase trade agreement lines where the currency matches the currency on the vendor.

The following table provides examples that show how various settings for a released product and its associated

purchase trade agreements affect the values that are found for the resulting planned purchase order. The boldbold

values in the two rightmost columns are the values that are selected by Planning Optimization. The bold andbold and

italicitalic values in the other columns are the settings that produced those resulting values for each row.
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Safety margins overview

Receipt marginReceipt margin

This topic describes how safety margins can be used with the Planning Optimization Add-in for Microsoft

Dynamics 365 Supply Chain Management.

The purpose of safety margins is to enable a setup that provides some buffer time beyond the normal lead time.

For example, when material must be unpacked or inspected after it arrives from the vendor, you can't just add

the extra time to the purchase lead time, because this approach will give the additional buffer time to the

supplier. In this example, the receipt margin can be used to ensure that the supplier delivers earlier. This

approach provides buffer time so that the goods can be handled internally.

There are three types of safety margins:

Reorder marginReorder margin – The buffer time for placing the supply order

Receipt marginReceipt margin – The buffer time for handling incoming supply

Issue marginIssue margin – The buffer time for handling shipments

The following illustration shows how these safety margins apply over time.

All margins are defined in days. The default value, 0 (zero), indicates that no margin is applied. If you set up

multiple margins, they all add to the total time from the supply order date to the demand requirement date. For

example, a setup has no lead time, and all three margin types are set to one day. In this case, there will be three

days between the supply order date and the demand requirement date, so if the order date is July 1, the

requirement date would be July 4.

The receipt margin is probably the most used of the three safety margins. It's applied to the delivery date and

backward from the requirement date. In other words, the products should be received the specified number of

receipt margin days before they are required.

The following illustration highlights the receipt margin.

The receipt margin is typically used as a buffer to ensure time for warehouse registration or other time-

consuming processes that aren't captured as part of the general lead time in the system. For purchases, one

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/planning-optimization/safety-margins.md


Reorder marginReorder margin

NOTENOTE

Issue marginIssue margin

NOTENOTE

benefit is that the delivery date of the purchase order is moved forward accordingly. If you increase the lead

time instead of using a safety margin, the vendor will still be asked to deliver at the last minute.

Notice that the receipt margin doesn't change the requirement date of the supply. Therefore, the receipt margin

isn't directly visible when requirement dates for demand and supply are compared (for example, on the NetNet

requirementsrequirements  page). For example, if the receipt margin is set to four days, and a purchase order line is planned

for receipt on the fifteenth of the month, master planning calculates the adjusted receipt date as the nineteenth

of the month.

Note that a receipt margin isn't applied when on-hand inventory is used as the supply. All on-hand inventory is

assumed to be available immediately, regardless of when it was actually received.

Coming soon:Coming soon:  This feature isn't yet supported for Planning Optimization. Until it's supported, all values that are entered

for Reorder margin added to item lead timeReorder margin added to item lead time will be treated as 0 (zero).

The following illustration highlights the reorder margin.

The reorder margin is added before the item lead time for all planned orders during master planning. Therefore,

it ensures additional time for a supply order to be placed. This margin is typically used as a buffer to ensure time

for approval processes or other internal processes that are required during the creation of supply orders. The

reorder margin is put between the supply order date and start date.

Coming soon:Coming soon:  This feature isn't yet supported for Planning Optimization. Until it's supported, all values that are entered

for Issue margin deducted from requirement dateIssue margin deducted from requirement date will be treated as 0 (zero).

The following illustration highlights the issue margin.

The issue margin is deducted from the demand requirement date during master planning. It helps ensure that

you have time to react to and ship incoming demand orders. This margin is typically used as a buffer to ensure

time for shipment and related outbound warehouse processes.

Notice that when an issue margin is applied, related supply and demand requirement dates don't match. Instead,

they differ by the issue margin, because the issue margin is added between the supply requirement date and the

demand requirement date.



Set up safety margins
Turn on safety margins in Feature managementTurn on safety margins in Feature management

Define safety marginsDefine safety margins

Coverage group safety marginsCoverage group safety margins

Master plan safety marginsMaster plan safety margins

Define whether calculations are based on calendar days or work daysDefine whether calculations are based on calendar days or work days

Before you can use this feature with Planning Optimization, it must be turned on in your system. Admins can

use the Feature management workspace to check the status of the feature and turn it on if it's required. There,

the feature is listed in the following way:

Module:Module: Master planning

Feature name:Feature name: Margins for Planning Optimization

Safety margins have a flexible setup. They can be set on both the coverage group and the master plan. It's

important that you understand that the margins are added on top of each other. For example, a receipt margin

of two days on the coverage group and three days on the master plan will produce an effective receipt margin

of five days.

The ability to set the margin on the master plan can be useful when you want to simulate longer lead times or

uncertainty for a specific plan, but without affecting the daily planning.

To apply a safety margin to a coverage group, follow these steps.

1. Go to Master planning > Setup > Coverage groupsMaster planning > Setup > Coverage groups .

2. In the list pane, select the desired coverage group.

3. On the OtherOther  FastTab, in the Safety margins in daysSafety margins in days  section, use the following fields to set the

required safety margins (in days):

Receipt margin added to requirement date

Issue margin deducted from requirement date

Reorder margin added to item lead time

To apply a safety margin to a master plan, follow these steps.

1. Go to Master planning > Setup > Plans > Master plansMaster planning > Setup > Plans > Master plans .

2. In the list pane, select the desired master plan.

3. On the Safety margins in daysSafety margins in days  FastTab, use the following fields to set the required safety margins (in

days):

Receipt margin added to requirement date

Issue margin deducted from requirement date

Reorder margin added to item lead time

You can set all safety margins so that they are calculated based on either calendar days or work days.

1. Go to Master planning > Setup > Master planning parametersMaster planning > Setup > Master planning parameters .

2. On the GeneralGeneral  tab, in the Safety margins in daysSafety margins in days  section, set the Working daysWorking days  option to Yes to

calculate margins based on working days. Set the option to No to calculate margins based on calendar days.

For example, a calendar is open from Monday through Friday and closed from Saturday through Sunday. If

there is a receipt margin of one day, a requirement date on a Monday produces a delivery date on the previous

Friday, because Saturday and Sunday aren't working days.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/fin-ops/get-started/feature-management/feature-management-overview
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Calendar that is used for the durationCalendar that is used for the duration

Calendar that is used for the final dateCalendar that is used for the final date

Calendar setup overview matrixCalendar setup overview matrix

The calendar that is used to determine the working days depends on the setup and the supply type. It can be

controlled by the calendars of the coverage group, the warehouse, and the vendor.

If warehouse isn't part of the coverage dimension (in other words, planning is based only on site), the warehouse calendar

isn't used.

The system can handle a setup where one or more calendars are defined. The following subsections describe the

possible combinations that can be used to control the result.

The defined calendars control the actual total lead time in calendar days, from the supply order date to the

demand requirement date. The following calendar prioritization is used:

Purchase lead timePurchase lead time – Only the coverage group calendar is considered.

Receipt marginReceipt margin – The coverage group calendar is used, if it's defined. Otherwise, the warehouse calendar is

used.

Issue marginIssue margin – The coverage group calendar is used, if it's defined. Otherwise, the warehouse calendar is

used.

Order marginOrder margin – Only the coverage group calendar is considered.

The following rules are applied to determine whether the planning engine can use a given date for a given date

type:

Purchase receipt datePurchase receipt date – The vendor calendar is used, if it's defined. Otherwise, the coverage group

calendar is used, if it's defined. If neither of those calendars is defined, the warehouse calendar is used.

Transfer receipt dateTransfer receipt date – The coverage group calendar is used, if it's defined. Otherwise, the warehouse

calendar is used.

Production receipt dateProduction receipt date – The coverage group calendar is used, if it's defined. Otherwise, the warehouse

calendar is used.

Demand issue open dayDemand issue open day  – The warehouse calendar is used, if it's defined. Otherwise, the coverage group

calendar is used.

Order open dayOrder open day  – A combination (intersection) of the coverage group calendar and the vendor calendar is

used. Both calendars must be open to use the date. If only one of the calendars is defined, that calendar is

used alone.

The following illustration presents a matrix that summarizes which calendars apply when safety margins are

calculated. (Select the image to open a high-resolution version of it.) The following abbreviations and colors are

used to indicate where each type of calendar is specified:

Coverage group (CG):Coverage group (CG): Green

Warehouse (WH):Warehouse (WH): Yellow

Vendor (V):Vendor (V): Blue



Calculating delays

Additional resources

NOTENOTE

All three types of safety margins are included when the system determines whether an order is delayed.

For example, an item has lead time of one day and a receipt margin of three days. A sales order for this item is

set as required today. In this case, the delay is calculated as lead time + receipt margin = four days. Therefore, if

today is August 14, the four days of delay produces a delivery on August 18. The following illustration shows

this example.

Get started with Planning Optimization

Planning Optimization fit analysis

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/supply-chain/master-planning/planning-optimization/media/safety-margins-calendar-matrix-high.png
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Purchase requisitions
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Enable master plans to include requisitions

Approved requisitions time fence

Set the approved requisitions time fence for a coverage groupSet the approved requisitions time fence for a coverage group

Set the approved requisitions time fence for individual master plansSet the approved requisitions time fence for individual master plans

IMPORTANTIMPORTANT

Independent supply, regardless of coverage code

Master planning can replenish approved purchase requisitions. Therefore, to cover purchase requisitions, users

don't have to use a workflow to create purchase orders. Instead, purchase requisitions can be covered by master

planning. Because of this functionality, a purchase requisition can produce a purchase order, a transfer order, or a

production order, depending on the Planned order typePlanned order type value that is set for the related product.

To include requisitions during the coverage calculation for a master plan, follow these steps.

1. Go to Master planningMaster planning > SetupSetup > PlansPlans  > Master plansMaster plans .

2. Create or select a master plan.

3. On the GeneralGeneral  FastTab, set the Include requisitionsInclude requisitions  option to Yes.

4. Repeat steps 2 and 3 for each additional master plan where you want to include requisitions.

The approved requisitions time fence establishes how far back (in days) a master plan will include demand from

approved replenishment requisitions. You can set an approved requisitions time fence at both the coverage

group level and the master plan level.

1. Go to Master planningMaster planning > SetupSetup > CoverageCoverage > Coverage groupCoverage group.

2. Create or select a coverage group.

3. On the OtherOther  FastTab, set the Approved requisitions time fence (days)Approved requisitions time fence (days)  field to the number of days to

include in the time fence.

4. Repeat steps 2 and 3 for each additional coverage group where you want to set an approved requisitions

time fence.

When you set an approved requisitions time fence for an individual master plan, the setting overrides the time

fence setting for any applicable coverage group.

1. Go to Master planningMaster planning > SetupSetup > PlansPlans  > Master plansMaster plans .

2. Create or select a master plan.

3. On the TIme fences in daysTIme fences in days  FastTab, set the Approved requisitions time fence (days)Approved requisitions time fence (days)  field to the

number of days to include in the time fence.

4. Repeat steps 2 and 3 for each additional master plan where you want to set an approved requisitions time

fence.

Coming soon:Coming soon:  Approved requisitions time fences aren't yet supported for Planning Optimization. Until they are

supported, all values that you enter in the Approved requisitions time fence (days)Approved requisitions time fence (days) field will be ignored.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/planning-optimization/purchase-requisitions.md
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Purchase requisitions are always covered by independent planned orders, regardless of the coverage code. This

behavior ensures clear traceability and workflows between purchase requisitions and replenishment orders.

A product is set up so that it has a Coverage codeCoverage code value of Min/max. It has the following inventory and

requisition statuses:

Inventory on-hand quantity = 10.

Minimum inventory quantity = 15.

Maximum inventory quantity = 20.

A purchase requisition for one piece exists. It has a requested date of today.

When master planning runs, two planned orders are created: one for 10 pieces to replenish inventory to the

maximum quantity, and one for one piece to replenish the purchase requisition.

A product is set up so that it has a Coverage codeCoverage code value of Min/max. It has the following inventory and

requisition statuses:

Inventory on-hand quantity = 17.

Minimum inventory quantity = 15.

Maximum inventory quantity = 20.

A purchase requisition for one piece exists. It has a requested date of today.

When master planning runs, one planned order for one piece is created to replenish the purchase requisition.

A product is set up so that it has a Coverage codeCoverage code value of Period and a period length of seven days. It has the

following inventory, sales order, and requisition statuses:

Inventory on-hand quantity = 0.

A sales order for five pieces exists. It has an expected ship date of today plus one day.

A purchase requisition for three pieces exists. It has a requested date of today plus three days.

When master planning runs, two planned orders are created: one for three pieces to replenish the purchase

requisition and one for five pieces to replenish sales order demand.

After a planned order that is pegged to a purchase requisition is firmed, the planning engine keeps the pegging to the

purchase requisition. If the firmed order is later found to be missing some quantity that is required to fulfill the purchase

requisition, the system will create a new planned order for the difference.

For more information about purchase requisitions, see Purchase requisition overview.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Planned production orders

Requirements from BOMs

Scheduling during firming

Delays

Planning Optimizations supports several production scenarios. If you're migrating from the existing, built-in

master planning engine, it's important that you be aware of some changed behavior.

The following video gives a short introduction to some of the concepts discussed in this topic: Dynamics 365

Supply Chain Management: Planning Optimization enhancements.

When master planning creates planned orders to fulfill requirements, the order type is determined by the value

of the Planned order typePlanned order type field. If the Planned order typePlanned order type field is set to Production, planned production

orders are created. These planned production orders include information about the active bill of materials

(BOM) and the route ID from the related production setup.

BOM information is honored during master planning. The plan output includes material supply to cover related

material demand for production.

During master planning, the current, active BOM is used to determine the materials that are required for

production. This step is done through all levels of the BOM structure that is related to the required production

order. Material requirement is fulfilled by using available on-hand inventory, existing on-order supply, and

approved planned orders. If additional material is required anywhere, a planned order is created to cover the

demand.

Planned production orders include the route ID that is required for production scheduling. However, scheduling

support during the planning run for planned orders is pending. The route ID is used to schedule planned

production orders during firming. Therefore, the lead time on planned production orders can differ from the

lead time on related scheduled, firmed production orders that are generated from them, as described here:

Planned production orderPlanned production order  – The lead time is based on the static lead time from the released product.

Firmed production orderFirmed production order  – The lead time is based on scheduling that uses route information and related

resource constraints.

For more information about expected feature availability, see Planning Optimization fit analysis.

If you depend on production functionality that isn't yet available for Planning Optimization, you can continue to

use the built-in master planning engine. No exception is required.

If the lead time for required material is longer than the period between today's date and the material

requirement date, the planned order for the required material and the related production order will be delayed.

For planned orders, the delay (in days) is calculated based on the lead time from the released product. The delay

information is then propagated through all levels of the BOM structure. Therefore, you can follow the impact of

delayed raw material all the way to the customer sales order.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/planning-optimization/production-planning.md
https://youtu.be/u1pcmZuZBTw


 

Modifying planned orders
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Explosion page

Filters
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When you change information on a planned order, you receive the following message: "Note that the impact of

manual changes on planned orders won't be reflected in the rest of the plan until the next master planning run."

If you want to change information on a planned order and see the impact on the related material requirements,

follow these steps.

1. Update the planned order.

2. Approve the planned order.

3. Run master planning.

When you run master planning, you should not use filters if planned production orders are included. For more

information, see the Filters section later in this topic.

If the delivery date of the planned order is changed to a later date, the demand might be pegged against a new planned

order. This behavior occurs when the new supply date causes a delay for the pegged demand but, according to the lead

time settings, the delay can be avoided.

You can use the ExplosionExplosion page to analyze the demand that is required for a specific production order or

planned production order, the related coverage, and pegging information. Information on the ExplosionExplosion page is

updated during master planning. You can't update the information directly from the ExplosionExplosion page.

For planning scenarios that include production, we recommend that you avoid filtered master planning runs. To

ensure that Planning Optimization has the information that is required to calculate the correct result, you must

include all products that have any relation to products in the whole BOM structure of the planned order.

Although dependent child items are automatically detected and included in master planning runs when the

built-in master planning engine is used, Planning Optimization doesn't perform this action.

For example, if a single bolt from the BOM structure of product A is also used to produce product B, all products

in the BOM structure of products A and B must be included in the filter. Because it can be very complex to ensure

that all products are part of the filter, we recommend that you avoid filtered master planning runs when

production orders are involved.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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This topic provides information about the options that are available for marking inventory in firmed orders

when you use Planning Optimization.

Marking is used to link supply and demand. It resembles pegging, which indicates how master planning expects

to cover demand. From a planning point of view, the main difference is that marking is more permanent than

pegging.

Marking was introduced to support special costing scenarios for first in, first out (FIFO) and last in, first out

(LIFO). However, it's now also used for some non-costing scenarios. Marking between supply and demand is

optional and almost permanent. Marking can be removed manually by a user, or it can be removed by running a

sales order line explosion where the Remove markingRemove marking option is selected.

Pegging is controlled by master planning during coverage to link demand with the required supply. Pegging can

be updated for each planning run to optimize the supply that is required to cover demand. When master

planning updates pegging information, it respects any existing marking.

Pegging starts by including relevant marking, on-hand reservations, and on-order reservations, in the following

sequence:

1. Marking between demand and supply

2. On-hand reservations

3. On-order reservations

When you firm a planned order, the FirmingFirming dialog box provides an Update markingUpdate marking field that you use to set

marking options for the orders that are created during firming. Select one of the following values:

NoNo – No inventory marking is applied.

StandardStandard – Inventory marking is updated according to the pegging. A requirement order (demand) is

marked against a fulfillment order (supply). If some quantity remains on the fulfillment order, it isn't marked,

and the reference information is left blank. For example, if a sales order for 100 ea is pegged against a

purchase order for 150 ea, reference information will be assigned only to the sales order.

ExtendedExtended – Both the requirement order (demand) and the fulfillment order (supply) are marked, regardless

of any quantity that remains on the fulfillment order. For example, if a sales order for 100 ea is pegged

against a purchase order for 150 ea, reference information will be assigned to both the sales order and the

purchase order.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Required setup

Include planned downstream demand

For some organizations, logistics operations depend on other legal entities (companies) in the organization.

These operations are handled by using intercompany sales and purchases, because each legal entity has a

separate chart of accounts.

This topic describes intercompany planning and explains how to configure intercompany planning with

Planning Optimization in Microsoft Dynamics 365 Supply Chain Management.

This topic uses the following important intercompany terms:

UpstreamUpstream – A relative reference in a firm or supply chain. It indicates movement in the direction of the raw

material supplier.

DownstreamDownstream – A relative reference in a firm or supply chain. It indicates movement in the direction of the

customer.

Planned intercompany demandPlanned intercompany demand – Planned demand for a product in a company, based on planned

demand for the product from a downstream company.

In master planning, a plan in one company can include planned intercompany demand that is related to planned

orders from a plan in another company. This capability is useful, because it provides full visibility into planned

orders across companies. It also ensures that all required planned supply orders are created, but without

requiring that planned orders be firmed for the intercompany demand.

If you run master planning from a master plan that includes planned downstream demand, planned purchase

orders from the related intercompany vendors will be included in the plan as demand.

To use intercompany planning, you must prepare your system in the following way:

1. The relevant products must be released in all the relevant companies. For more information, see Configure

and use intercompany trade in Dynamics 365 Supply Chain Management on Microsoft Learn.

2. Downstream demand must be covered by purchases from a vendor that has an intercompany relation to the

upstream company and relevant default inventory dimensions (site and warehouse) on the customer. For

more information, see Configure and use intercompany trade in Dynamics 365 Supply Chain Management

on Microsoft Learn.

3. The master plan in the upstream company must include planned downstream demand, and the relevant

company and master plan must be specified in the downstream plans.

Follow these steps to configure your master plan so that it includes planned downstream demand.

1. Go to Master planning > Setup > Plans > Master plansMaster planning > Setup > Plans > Master plans .

2. Select or create a master plan.

3. On the Intercompany planningIntercompany planning FastTab, set the following fields:

Include planned downstream demandInclude planned downstream demand – Set this option to Yes to enable intercompany planning

for the master plan.

Downstream plansDownstream plans  – If you set the Include planned downstream demandInclude planned downstream demand option to Yes, use the

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/planning-optimization/Intercompany-planning.md
https://docs.microsoft.com/en-us/learn/modules/configure-use-intercompany-trade-dyn365-supply-chain-mgmt/
https://docs.microsoft.com/en-us/learn/modules/configure-use-intercompany-trade-dyn365-supply-chain-mgmt/


Peg across companies by using multilevel pegging

Intercompany example that involves two companiesIntercompany example that involves two companies

Intercompany example that involves three companiesIntercompany example that involves three companies
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toolbar and grid to add the desired master plans from other companies.

In multilevel pegging, you can view pegging across companies to see the initial source of demand that is being

covered by a supply.

To view multilevel pegging information, follow these steps.

1. Go to Master planning > Master planning > Planned ordersMaster planning > Master planning > Planned orders .

2. Select or open a planned order.

3. On the Action Pane, on the ViewView  tab, in the RequirementsRequirements  group, select Multilevel peggingMultilevel pegging.

For this example, a planned production order is created in the USMF company to cover a sales order in the

DEMF company. In USMF, the direct demand is planned intercompany demand. To make this demand appear in

USMF, master planning is run first in DEMF and then in USMF.

The following illustration shows how this example might appear on the Multilevel peggingMultilevel pegging page for the

planned production order.

For this example, a planned purchase order is created in the USMF company to cover a sales order in the FRRT

company. In the DEMF and USMF companies, the direct demand is planned intercompany demand. To make this

demand appear in USMF, master planning is run first in FRRT, then in DEMF, and finally in USMF.

The following illustration shows how this example might appear on the Multilevel peggingMultilevel pegging page for the

planned production order.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Released products and released product versions include a Product lifecycle stateProduct lifecycle state field. This field lets you

control, among other things, which products are included during master planning. You can add, remove, and edit

lifecycle states as required by going to Product information management > Setup > Product lifecycleProduct information management > Setup > Product lifecycle

statestate. For each product lifecycle state, set the Is active for planningIs active for planning option to Yes if products that have that

state should be included during master planning. When the option is set to No, the associated products and

variants will be excluded from all master planning and all calculations at the bill of materials (BOM) level.

Released products and variants where the Product lifecycle stateProduct lifecycle state field is left blank are treated as though they

have a product lifecycle state where the Is active for planningIs active for planning option is set to Yes. In other words, they will be

included during master planning.

To help avoid unnecessary supply suggestions, we strongly recommend that you associate all obsolete released products

and variants with a product lifecycle state where the Is active for planningIs active for planning option is set to No. This approach is

especially important when you work with product configuration variants that aren't reusable, because it will help prevent

waste.

For more information about product lifecycle states, see Product lifecycle state overview.

For detailed information that includes steps for using product lifecycle states to exclude products from master

planning and BOM-level calculations, see Create a product lifecycle state to exclude products from Master

planning.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/planning-optimization/product-lifecycle-state.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Coverage time fences
2/18/2021 • 5 minutes to read • Edit Online

Set a coverage time fence for a coverage group

Set a coverage time fence for a specific item

This topic describes how to set up coverage time fences when you're using Planning Optimization. Planners can

define the planning horizon (the coverage time fence in days), and exclude supply and demand that falls beyond

that horizon. Therefore, coverage time fences help prevent "noise" that is caused by supply suggestions that you

don't have to react to for months. Examples include next year's forecast and customer orders that are placed far

beyond the normal lead time.

A coverage time fence is the number of days after today's date (or, more precisely, the date when you do the

planning run) that supply and demand is excluded. To help avoid delays, you must ensure that the coverage time

fence is longer that the total lead time. The default system value is 100 days.

You can specify a coverage time fence at each of the following levels:

Coverage groupCoverage group – You can set a default coverage time fence for each coverage group.

Item coverageItem coverage – You can override the coverage time fence that is inherited from the coverage group that is

assigned to an item.

Master planMaster plan – You can override the coverage time fences that are inherited from the coverage group and

item coverage settings.

The following sections explain how to specify a coverage group at each level.

When you specify a coverage time fence for a coverage group, the setting applies to all items (products) that

belong to that group. However, you can override the setting for specific items or specific master plans.

To specify a coverage time fence for a coverage group, follow these steps.

1. Go to Master planning > Setup > Coverage > Coverage groupsMaster planning > Setup > Coverage > Coverage groups .

2. Select an existing coverage group in the list, or create a new coverage group.

3. On the GeneralGeneral  FastTab, set the Coverage time fence (days)Coverage time fence (days)  field to the number of days that you want to

use as the coverage time fence for the coverage group.

Every item (product) belongs to a coverage group. If no coverage group is explicitly assigned to an item, a

default coverage group applies. Every item inherits a coverage time fence from its coverage group. However,

you can override this time fence for specific items as you require.

To specify a coverage time fence for a specific item, follow these steps.

1. Go to Product information management > Products > Released productsProduct information management > Products > Released products .

2. Select a product in the grid.

3. On the Action Pane, on the PlanPlan tab, in the CoverageCoverage group, select Item coverageItem coverage.

4. On the Item coverageItem coverage page, on the Over viewOver view  tab, select or create a row for the site where you want to set

a coverage time fence.

5. Select the GeneralGeneral  tab to open the settings for the selected site.

6. Select the Overr ide coverage group settingsOverr ide coverage group settings  check box.

7. Set the Coverage time fence (days)Coverage time fence (days)  field to the number of days that you want to use as the coverage time
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fence for the item.

You can specify a coverage time fence at the master plan level. In this way, you define the number of days that

the master planning calculation covers for a master plan. This setting overrides any coverage time settings that

have been defined for each relevant item and coverage group.

To specify a coverage time fence for a specific master plan, follow these steps.

1. Go to Master planning > Setup > Plans > Master plansMaster planning > Setup > Plans > Master plans .

2. Select an existing master plan in the list, or create a new master plan.

3. On the Time fences in daysTime fences in days  FastTab, set the CoverageCoverage option to Yes. Then, in the field under the option,

enter the number of days that you want to use as the coverage time fence for the master plan.

As you're setting up coverage time fences, consider the following points:

Coverage time fences affect only input data for master planning. If delays occur, the resulting planned orders

might have a date that is after today's date plus the coverage time fence.

Coverage time fences are specified in calendar days. Calendars that use working days won't affect the time

fence calculation. For example, a week is always considered seven days, even if weekends are set up as closed

days in the working time calendar.

Requirement transactions won't be generated for any supply and demand that falls outside the coverage

time fence.

If any approved supply and demand falls outside the coverage time fence, it won't be loaded into the engine.

Therefore, it won't trigger any replenishment, and delays won't be calculated. Nevertheless, this supply and

demand should not be wiped from the system.

Variations in safety stock quantities (from minimum keys) will be ignored if they fall outside the coverage

time fence.

Intercompany demand will be ignored if the requested ship date that is calculated isn't inside the coverage

time fence. Note that, for built-in master planning, intercompany demand isn't limited by the coverage time

fence.

Demand forecasts will be ignored if the budget date isn't inside the coverage time fence. Note that, for built-

in master planning, demand forecasts aren't limited by the coverage time fence.

Planning Optimization is time zone–aware. It considers the time zone at the supply and demand sites, and

the time of the planning run. For example, master planning is triggered at 11 AM on October 15 from a site

in Denmark (GMT+1 time zone), and a coverage time fence of ten days is used. In this case, supply and

demand from a site in Seattle (GMT-8 time zone) is included until 2 AM on October 25 (= ten 24-hour days

after master planning was triggered, minus the time zone difference of nine hours). Note that the built-in

master planning engine considers only the date of the time fence. Therefore, the result can differ.
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This topic provides information about how to update the status of planned orders in Planning Optimization.

Note that approval of planned orders is an optional step, on the way to create a firmed order from a planned

order. It is recommended to approve modified planned orders, otherwise the edits will be ignored and

overwritten by the next planning run.

The StatusStatus  field helps you tack your progress using the following values:

Unprocessed:Unprocessed: When master planning generates planned orders, the planned orders have a status of

Unprocessed. Planned orders with this status will be deleted during the next planning run.

Completed:Completed: If you decide not to firm a planned order, you can change the status to Completed to indicate

that you completed evaluating this planned order. Note that a status of Unprocessed and Completed are

treated the same by the system.

Approved:Approved: If you want to keep edits or are planning to firm a planned order, change the status to Approved.

Planned orders with Approved status are considered as fixed and expected supply by master planning, so

they are not modified or deleted during later master planning runs. To achieve this, the planning logic copies

the Approved planned orders from the old plan version to the new plan version during master planning.

Note that Approved planned orders are only considered supply within the specific master plan.

You can manage planned orders from the Master planningMaster planning workspace, the Planned orderPlanned order  list, or the

Planned production ordersPlanned production orders , Planned purchase ordersPlanned purchase orders , and Planned transferPlanned transfer  lists.

Can you tell us about your documentation language preferences? Take a short survey.
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Turn on autofirming

Set up the firming time fence

Planning Optimization vs. the built-in Supply Chain Management
planning engine

Automatic firming lets you firm (that is, release) planned orders as part of the master planning process. When

planned orders are firmed, they are transformed into actual purchase orders, transfer orders, or production

orders. When Planning Optimization is used, planned orders are firmed during a master planning run when the

order date (that is, the start date) is within the time fence for firming.

Auto-firming of a planned purchase order can occur only if the item is associated with a vendor.

To turn on autofirming, follow these steps.

1. In the Feature managementFeature management workspace, on the NewNew  tab, select Auto-firming for PlanningAuto-firming for Planning

OptimizationOptimization in the list. If the feature doesn't appear on the NewNew  tab, look on the Not enabledNot enabled and AllAll

tabs.

2. Select Enable nowEnable now . Alternatively, select ScheduleSchedule, and then select the time when you want the feature to be

turned on.

The firming time fence is calculated forward from the master planning run date. It's defined by the number of

days that you enter. You can control the firming time fence in the following ways:

To define the default firming time fence for a coverage group, go to Master planningMaster planning > SetupSetup > CoverageCoverage

> Coverage groupsCoverage groups , and select a coverage group. Then, on the OtherOther  FastTab, in the Automatic firmingAutomatic firming

time fence (days)time fence (days)  field, enter the number of days.

To overwrite the firming time fence that is defined for the coverage group for a specific item, go to ProductProduct

information managementinformation management > Released productsReleased products , then from the Action Pane select PlanPlan and then select

Item coverageItem coverage. Then, on the GeneralGeneral  tab, select Overr ide time fenceOverr ide time fence and in the Automatic firmingAutomatic firming

time fence (days)time fence (days)  field, enter the number of days.

To overwrite the firming time fence that is defined for the coverage group and item coverage for a specific

master plan, go to Master planningMaster planning > SetupSetup > Master plansMaster plans , and select a Master plan. Then, on the TimeTime

fence in daysfence in days  FastTab, set FirmingFirming to YesYes , and enter the number of days.

If autofirming is turned on for a master planning run that uses Planning Optimization, the autofirming process is

done according to the autofirming setup. If autofirming isn't turned on, or if planning is started from the NetNet

requirementsrequirements  page, the autofirming process is skipped.

Both Planning Optimization and the planning engine that is built into Microsoft Dynamics 365 Supply Chain

Management can be used to autofirm planned orders. However, there are some important differences. For

example, whereas Planning Optimization uses the order date (that is, the start date) to determine which planned

orders to firm, the built-in Supply Chain Management planning engine uses the requirement date (that is, the
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end date). Here is a summary of the differences.

Planning OptimizationPlanning Optimization

Autofirming is based on the order date (start date).

Because the order date (start date) triggers the firming, you don't have to consider the lead time as part of

the firming time fence.

If you want to firm all orders that must start during the current week, the firming time fence must be one

week.

Built-in Supply Chain Management planning engineBuilt-in Supply Chain Management planning engine

Autofirming is based on the requirement date (end date).

To help guarantee that orders are firmed in due time, the firming time fence must be longer than the lead

time.

If you want to firm all orders that must start during the current week, the firming time fence must be the lead

time plus one week.
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Example 1

Example 2

If the system shows a negative aggregate on-hand quantity, the planning engine treats the quantity as 0 (zero)

to help avoid over-supply. Here is how this functionality works:

1. The planning optimization feature aggregates on-hand quantities at the lowest level of coverage dimensions.

(For example, if location isn't a coverage dimension, planning optimization aggregates on-hand quantities at

the warehouse level.)

2. If the aggregate on-hand quantity at the lowest level of coverage dimensions is negative, the system

assumes that the on-hand quantity is really 0 (zero).

The planning system can be only as precise as the input data. If the input data is inaccurate, negative on-hand records will

indicate that the inventory information in Microsoft Dynamics 365 Supply Chain Management is out of sync with the real

world. Therefore, the planning result will be flawed. To get a precise planning result, you should minimize the number of

records that show a negative on-hand quantity.

Warehouse 13 is configured in the following manner :

Coverage code:Coverage code: Min./Max.

Minimum:Minimum: 15 pieces (pcs.)

Maximum:Maximum: 25 pcs.

The lowest level of coverage dimensions is warehouse, and the following on-hand quantities are recorded at the

location level:

S ite 1 , warehouse 13, location 1:S ite 1 , warehouse 13, location 1: 20 pcs.

S ite 1 warehouse 13, location 2:S ite 1 warehouse 13, location 2: −8 pcs.

Therefore, the aggregate on-hand quantity for warehouse 13 is 12 pcs. (= 20 pcs. − 8 pcs.).

In this case, the planning engine uses an aggregate on-hand quantity of 12 pcs. for warehouse 13.

The result is a planned order of 13 pcs. (= 25 pcs. − 12 pcs.) to refill warehouse 13 from 12 pcs. to 25 pcs.

Warehouse 13 is configured in the following manner :

Coverage code:Coverage code: Min./Max.

Minimum:Minimum: 15 pcs.

Maximum:Maximum: 25 pcs.

The lowest level of coverage dimensions is warehouse, and the following on-hand quantities are recorded at the

location level:

S ite 1 , warehouse 13, location 1:S ite 1 , warehouse 13, location 1: 4 pcs.

S ite 1 warehouse 13, location 2:S ite 1 warehouse 13, location 2: −8 pcs.
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Therefore, the aggregate on-hand quantity for warehouse 13 is −4 pcs. (= 4 pcs. − 8 pcs.). In other words, it's

less than 0 (zero).

In this case, the planning engine assumes that the on-hand quantity for warehouse 13 is 0 pcs. instead of −4

pcs.

The result is a planned order of 25 pcs. (= 25 pcs. − 0 pcs.) to refill warehouse 13 from 0 pcs. to 25 pcs.

Planning Optimization overview

Get started with Planning Optimization

Planning Optimization fit analysis

View plan history and planning logs

Cancel a planning job
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This topic explains how to view the history of planning jobs that are triggered by the Planning Optimization

functionality in Microsoft Dynamics 365 Supply Chain Management.

To view the history for a plan, open the plan by going to Master planningMaster planning > SetupSetup > PlansPlans  > Master plansMaster plans

and selecting Histor yHistor y . The history lists all the jobs for the selected plan. The list includes completed and active

jobs.

In addition to seeing the start time and status of jobs, you can view the log for a specific job. The log includes

additional information and warnings. Not all jobs have a log. To view the log for a job, select LogLog.

Planning Optimization overview

Get started with Planning Optimization

Planning Optimization fit analysis

Apply filters to a plan

Cancel a planning job
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In Microsoft Dynamics 365 Supply Chain Management, you can cancel an active planning job that uses the

Planning optimization functionality. When you select CancelCancel  in the dialog box when a Planning optimization job

is triggered directly from the user interface (not in the background), this will not cancel the Planning

optimization job. Even if you receive a warning such as “Operation canceled”, you will still need to use the

following steps to cancel a planning job with Planning optimization.

To cancel an active planning job, follow these steps.

Only active jobs can be canceled.

1. Go to Master planning > Setup > PlansMaster planning > Setup > Plans .

2. Select an appropriate plan for the planning run.

3. Select Histor yHistor y .

4. Select the planning job to cancel.

5. Select CancelCancel .

The job status will be CancelingCanceling until the Planning Optimization service confirms that the job has been

canceled. The status will then be changed to CanceledCanceled.

To see status changes, you must refresh the page by selecting the RefreshRefresh button.

Planning Optimization overview

Get started with Planning Optimization

Planning Optimization fit analysis

View plan history and planning logs

Apply filters to a plan
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Installation of the Planning Optimization add-in doesn't complete

Planning of batch jobs fails when Planning Optimization is enabled

Planning Optimization results are different from earlier results

Can't enable Planning Optimization

Error message is shown during CTP

Additional resources

This topic describes how to fix common issues that you might encounter while working with Planning

Optimization.

Planning Optimization requires a Lifecycle Services (LCS) enabled, high-availability environment, tier 2 or higher

(not a OneBox environment), with Dynamics 365 Supply Chain Management version 10.0.7 or later. If you try to

install the add-in on a OneBox environment, the installation won't complete.

FixFix: Cancel the installation and use a high-availability environment, tier 2 or higher (not a OneBox environment).

When you enable Planning Optimization, the built-in master planning engine is automatically disabled. Master

planning batch jobs that were created for the built-in Supply Chain Management planning engine will fail if they

are triggered while Planning Optimization is enabled. You may receive an error message such as This operation

triggered master planning that isn't supported when Planning Optimization is enabled.

FixFix: Cancel all master planning batch jobs that were created for the built-in Supply Chain Management planning

engine.

Planning Optimization differs from the built-in master planning design in some areas. This can also be caused

by pending features.

FixFix: Run Planning Optimization fit analysis and then analyze the results while referring to the related

documentation to understand the impact. For more information, see Planning Optimization fit analysis.

The Connection statusConnection status  must be ConnectedConnected before you can set Use Planning OptimizationUse Planning Optimization to YesYes . For

more information, see Get started with Planning Optimization.

FixFix: Make sure that the Planning Optimization add-in was installed successfully.

If you try to run capable to promise (CTP) from a sales order when Planning Optimization is enabled, you will

receive the following error message: This operation triggered master planning that isn't supported when the

Planning Optimization is enabled.

This is related to a pending feature that is planned as part of the support for production orders.

Fix:Fix: Avoid CTP calculations when Planning Optimization is enabled until CTP support is available.

Get started with Planning Optimization
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Planning Optimization fit analysis

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Planning Optimization extensibility
2/18/2021 • 2 minutes to read • Edit Online

Custom processing when master planning is completed

public static void jobCompletedSuccessfully(MpsMasterPlanningJobCompletedSuccessfullyEventArgs _args)

[ExtensionOf(classStr(MpsMasterPlanningEvents))]
public static final class MpsMasterPlanningEvents_Cstm_Extension
{
    public static void jobCompletedSuccessfully(MpsMasterPlanningJobCompletedSuccessfullyEventArgs _args)
    {
        ttsbegin;

        var affectedPlannedOrdersQuery = 
_args.parmPostProcessingQueryBuilder().buildAffectedPlannedOrdersQuery();
        var affectedPlannedOrdersQueryRun = new QueryRun(affectedPlannedOrdersQuery);

        while (affectedPlannedOrdersQueryRun.next())
        {
            ReqPO reqPO = affectedPlannedOrdersQueryRun.get(tableNum(ReqPO));
            reqPO.selectForUpdate(true);
            reqPO.CstmOrderPriority = reqPO.ReqDate - systemDateGet() < 7 ? CstmPlannedOrderPriority::Urgent 
: CstmPlannedOrderPriority::Regular;
            reqPO.doUpdate();
        }

        ttscommit;

        next jobCompletedSuccessfully(_args);
    }

}

This topic describes the extensibility scenarios that are related to master planning and supported in Planning

Optimization. These capabilities are available starting in Microsoft Dynamics 365 Supply Chain Management

version 10.0.13.

In the most common extensibility scenario in Planning Optimization, custom processing is done after the plan

has been updated. For example, you might add a column to the planned orders table ( ReqPO ), or you might

want to derive some statistical information from the generated plan. The main extensibility point that enables

these scenarios is the jobCompletedSuccessfully  method in the MpsMasterPlanningEvents  class.

Here is an example of an extension that sets a custom CstmOrderPriority  field on the planned order.

When you add custom logic, consider the following constraints and best practices:

The jobCompletedSuccessfully  method is called outside the transaction scope. Therefore, the plan is already

visible to the user when the custom logic starts to run. If your customization sets additional fields on planned

orders, it's important that you let users know that the values of those fields will eventually be consistent (in

other words, they might be out of date immediately after a planning job is completed).

Another master planning job can start when the jobCompletedSuccessfully  method is called. The new job

might affect the full plan or part of the plan. The new job might update or delete the same planned orders or

requirement transactions that were created or updated as part of the planning job that was handled in 
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jobCompletedSuccessfully . Update conflict exceptions must be handled when this event is extended.

Avoid using single transaction scope when you extend this method. A single master planning run can

produce millions of requirement transactions and hundreds of thousands of planned orders. If all these

transactions and planned orders are processed in the scope of a single transaction, many SQL locks will

occur and block other planning processes. Additionally, if the transaction is held for a long time, "ghost

records" will be created in the SQL database. Ghost records will negatively affect every process in the system.
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Use various master plans to support your company's daily working operations, simulate different planning

strategies that you want to monitor, and implement a company policy, such as a policy about internal

performance or customer satisfaction.

You can configure master plans on the Master plansMaster plans  page.

There are two types of plans:

Static planStatic plan – The master planning calculation uses the current data to generate a net requirements plan.

This plan remains unchanged until the next time that you run master planning or manually change the plan.

This is an operating plan that various company personnel, such as a purchaser or production planner, can use

to base their decisions on and perform their daily activities.

Dynamic planDynamic plan – This plan starts with the same net requirements plan that was generated by master

planning. However, you can update the dynamic plan every time that the master data changes. This could be

when you create a new sales order, for example. This enables you to monitor the changing order network and

item availability without disturbing the static plan that others are using for their work processes.

A company may choose to work with just a dynamic plan or it may use both static and dynamic plans. In

addition, you can configure any master plan to reflect a particular strategy or address an issue. Examples are as

follows:

Set higher inventory levels to guarantee against stockouts.

Set longer safety margins to protect against unreliable vendors.

You can also set up the starting dynamic plan so that it is updated with the new requirements plan every time

that you run master planning. You can specify these settings on the Master planning parametersMaster planning parameters  page.

Coverage settings

Separating tactical and operative planning for master scheduling

Master Planning: Use a static and dynamic Master Plan or use one plan?
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Types of master plans

Static planStatic plan

Dynamic planDynamic plan

Strategies for using master plans

One-plan strategyOne-plan strategy

Two-plan strategyTwo-plan strategy

This topic describes various important strategies and parameters that are used to set up master planning. It

includes an overview of the types of plans that are used by master planning and explains which plan strategy

you should use, depending on your business requirements. It also describes the main parameters that affect the

plan and explains how those parameters influence the planned orders that are suggested.

Master planning has two types of plans: static and dynamic. Each type is designed for a different use. For the

best performance, we recommend that you use the appropriate plan for your scenario.

The static plan remains unchanged, regardless of any changes in the supply and demand, until the next time that

master planning is run.

The static plan is used to approve and firm the orders that are suggested. It's an operating plan that various

company personnel (such as a purchaser or production planner) can base their decisions on and use to perform

their daily tasks and activities.

The static plan also supports regeneration. A totally new optimized plan is calculated every time that master

planning is run, and existing orders that haven't been approved are deleted.

The dynamic plan usually starts as a copy of the static plan, but it can be updated every time that master data

changes. For example, if the data changes, a new sales order is created.

The dynamic plan is used for ad-hoc planning. It lets the company monitor the changing order network and item

availability without disturbing the static plan that other people are using for their work processes. It's especially

used for capable to promise (CTP). The dynamic plan is the default plan when net requirements are opened from

order pages (such as sales order, purchase order, or production order pages).

The dynamic plan uses net change. Therefore, it helps guarantee a faster running time.

You can use either one plan or two plans in master planning. The strategy that you use depends on your

business requirements.

For the one-plan strategy, you use the same master plan for the static plan and the dynamic plan. This strategy is

used for make-to-stock scenarios, where you don't usually have to simulate a plan that fulfills an order.

The one-plan strategy is typically used in retail and distribution industries, or where sales delivery dates are

confirmed based on service level agreements (SLAs) or lead times. For the plan, delivery date control can be

used without CTP.

If you must do a simulation, the plan can be run again for the items that require the simulation. The planned

orders that order simulations produce are usually firmed.
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Types of planning methods

RegenerationRegeneration

Net changeNet change

Net change minimizedNet change minimized

Types of scheduling methods

For the two-plan strategy, you use a static plan and a different dynamic plan. The two-plan strategy is typically

used for configure-to-order and make-to-order scenarios, where you must do sales order simulations and

calculate exact delivery dates for sales orders, but the calculations must not affect everyday operations. These

simulations are always done in the dynamic plan. The two-plan strategy is useful in the automotive and original

equipment manufacturer (OEM) industries, for example.

For the two-plan strategy, delivery date control CTP can be used. When CTP is used, it automatically triggers the

run in the dynamic plan.

You can create plans on the Master plansMaster plans  page (Master planning > Setup > Plans > Master plansMaster planning > Setup > Plans > Master plans ).

You can specify which plans will be used for the static plan and the dynamic plan by setting the Current staticCurrent static

master planmaster plan and Current dynamic master planCurrent dynamic master plan fields on the Master planning parametersMaster planning parameters  page (MasterMaster

planning > Setup > Master planning parametersplanning > Setup > Master planning parameters ). To use a one-plan strategy, select the same plan in the

Current static master planCurrent static master plan and Current dynamic master planCurrent dynamic master plan fields.

Three calculation methods can be used to run master planning: regeneration and net change. Each method

produces a different plan when it's run.

You specify the planning method in the Master planning runMaster planning run dialog box. To open this dialog box, go to

Master planning > Master planning > Run > Master planningMaster planning > Master planning > Run > Master planning, or select RunRun in the Master planningMaster planning

workspace.

The regeneration planning method deletes existing planned orders, unless they are firmed. It generates new

planned orders, based on all the requirements. Regeneration is the only planning method that is available for

static plans.

Changes in supply are considered. These changes include changes in the forecast.

This method respects the PeriodPeriod coverage code.

This method supports product substitution functionality (PI).

The net change planning method generates planned orders to cover the requirements that have been created or

changed since the last master planning run. Changes in supply aren't considered when this method is run. The

system doesn't consider any new supplies, and previously created planned orders aren't deleted if they are no

longer required. The net change planning method runs faster than the regeneration method. It's available only

for dynamic plans.

Action dates and futures are updated for all requirements.

This method doesn't respect the PeriodPeriod coverage code.

This method doesn't fulfill the forecast, even if it's selected on the plan.

This method doesn't support product substitution functionality (PI).

The net change minimized planning method generates planned orders to cover only the requirements that have

been created or changed since the last master planning scheduling run. For this method, unlike the net change

method, action dates and future dates are updated only for new or changed requirements. This planning

method is available only for dynamic plans.
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CoverageCoverage
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FreezeFreeze

FirmingFirming

For each plan, on the GeneralGeneral  FastTab of the Master plansMaster plans  page (Master planning > Setup > Plans >Master planning > Setup > Plans >

Master plansMaster plans ), you must select the scheduling method that is used for production orders. You can schedule

production at the operation level and the job level.

You can use operations scheduling to provide a general estimate of the production process over time.

Operations scheduling doesn't explode the operations for the production route into jobs. For more information

about operations scheduling, see Operations scheduling.

Job scheduling is a more detailed scheduling method, where each operation is divided into its individual tasks or

jobs. Job scheduling includes information about capacity. It's typically used to schedule individual jobs on the

shop floor for an immediate or short-term time frame. For more information about job scheduling, see Job

scheduling.

For each plan, you can select how far in the future the various requirements and other considerations must be

calculated by master planning. The period is known as a time fence. For the best performance in master

planning, we recommend that you adjust the various time fences to meet your business requirements. For each

plan, you can find the time fences on the Time fences in daysTime fences in days  FastTab of the Master plansMaster plans  page (MasterMaster

planning > Setup > Plans > Master plansplanning > Setup > Plans > Master plans ).

The time fences indicate how far in the future the various requirements and other considerations are calculated by master

planning. The time fences selected in this page will override the time fences defined in the coverage group. This means

setting a time fence option to yes and defining the days will override the time fence defined in the coverage group. When

setting to No, the time fence will be defined in the coverage group. Finally, if you don't want or need to use an option (for

example you do not want to use action messages), set it to YesYes , and then set the time fence to 00  (zero) days.

The coverage time fence represents the scheduling period, or how far out the demand should be included. In

other words, it indicates your planning horizon.

By setting the CoverageCoverage option to YesYes , you can override the coverage time fence that is defined for the item

during master scheduling. In this case, enter the number of days that the master scheduling calculation should

cover requirements. The coverage time fence is calculated forward from the current date. Requirements that

occur before the current date are always processed.

For the best performance in master planning, we recommend that you adjust the coverage time fence to your planning

horizon.

The freeze time fence represents the period when existing planned orders aren't changed when a new master

schedule is run. The planned orders are frozen, and no new planned orders will be suggested.

By setting the FreezeFreeze option to YesYes , you can override the freeze time fence that is defined for the item during

master scheduling. In this case, enter the number of days that planning activity should be frozen. Remember

that, during this period, no new planned orders are generated, and existing planned orders can't be changed.

https://docs.microsoft.com/en-us/dynamics365/unified-operations/supply-chain/production-control/operations-scheduling
https://docs.microsoft.com/en-us/dynamics365/unified-operations/supply-chain/production-control/job-scheduling
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Calculated delaysCalculated delays

Approved requisitions time fenceApproved requisitions time fence

The firming time fence indicates the time horizon in which planned orders are automatically converted to

production and purchase orders. This process is also known as automatic firming of planned orders.

By setting the FirmingFirming option to YesYes , you can override the firming time fence that is defined for the item during

master scheduling. In this case, enter the number of days that planned purchase orders and planned production

orders should be automatically firmed. The firming time fence is calculated forward from the master scheduling

date. Automatic firming of a planned purchase order can occur only if the item is associated with a vendor.

The forecast plan time fence indicates how far in the future master planning creates planned orders for items

that have forecasted demand.

By setting the Forecast planForecast plan option to YesYes , you can override the forecast plan time fence that is defined for the

item during master scheduling. In this case, enter the number of days that the sales forecast from the forecast

plan should be included in master planning.

The capacity time fence indicates how far in the future the system considers the maximum capacity of your

resources when it schedules orders. In other words, the plan schedules the production orders by using the

production route for the items, and it considers the production route's resources and the maximum capacity of

each resource.

By setting the CapacityCapacity  option to YesYes , you can override the capacity time fence that is defined for the item

during master scheduling. In this case, enter the number of days that capacity should be planned for planned

production orders. Master scheduling uses the active production route for the item and schedules backward

from the requirement date. If the requirement date for a planned production order is outside the capacity time

fence, the lead time is determined by the delivery time of the item. The capacity time fence is calculated forward

from the current date.

Action messages suggest changes that can be made to the existing supply order to help optimize the supply

plan. For example, they might recommend that you advance or postpone orders, or that you increase or

decrease the order quantities.

By setting the Action messageAction message option to YesYes , you can override the action message time fence that is defined

for the item during master scheduling. In this case, enter the number of days that master scheduling should

generate action messages for requirements. The action message time fence is calculated forward from the

current date.

For more information about action messages, see Action messages.

The calculation of action messages causes a longer running time for master planning. If action messages aren't regularly

analyzed and applied (daily, weekly, and so on), consider turning off the calculation during the master planning run. To

turn off the calculation, on the Master plansMaster plans page, set the Action messageAction message time fence to 00  (zero) for the master plan

that you're running. Also make sure that the Action messageAction message setting is turned off for all the coverage groups.

You can specify how far in the future possible delays in planned orders are detected and reported. In this way,

you can schedule possible (delayed) delivery dates.

If a planned order can't be fulfilled for the requested date, it's planned for the earliest fulfillment date for a

transaction, based on lead times, and material and capacity availability.

https://docs.microsoft.com/en-us/dynamics365/unified-operations/supply-chain/master-planning/action-messages
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You can set up master planning to create planned orders for requisition demand. Set the Include requisitionsInclude requisitions

option to YesYes  on the GeneralGeneral  FastTab of the Master plansMaster plans  page. Then, when the purpose of an approved

requisition is replenishment, master planning automatically creates a corresponding planned order to fulfill it.

The replenishment method is determined by the supply policies that have been set up for the items in your

organization. After the replenishment requisition is created and approved, no additional user action is required.

By setting the Approved requisitions time fenceApproved requisitions time fence option to YesYes  on the Time fences in daysTime fences in days  FastTab, you

can override the approved requisitions time fence that is defined for the item during master scheduling. In this

case, enter the number of days in the past that demand from approved requisitions that have the replenishment

purpose should be included in master scheduling. For example, you can specify that only unfulfilled, past-due

demand from approved requisitions that were created in the last 10 days should be considered and planned for.

Sequencing enables planned orders to be arranged based on sequencing attributes that are associated with the

finished product. It's often used to prepare production orders for packaging. For example, it can be used to pack

boxes in a specific sequence, based on color and size.

By setting the SequencingSequencing option to YesYes , you can specify how far in the future the operations or jobs should be

sequenced. Keep in mind that the longer the time fence is, the longer it will take for master planning to run.

Delay options help guarantee that the orders have feasible planned dates. The following options are available on

the Calculated delaysCalculated delays  FastTab of the Master plansMaster plans  page:

Ensure that the planned orders are not created pr ior to master planning run dateEnsure that the planned orders are not created pr ior to master planning run date – Set this option

to YesYes  to help guarantee that orders can't be scheduled for dates in the past.

Add the calculated delay to the requirement dateAdd the calculated delay to the requirement date (under Planned purchase ordersPlanned purchase orders ) – Set this

option to YesYes  to add the calculated delay to the requirements.

Add the calculated delay to the requirement dateAdd the calculated delay to the requirement date (under Planned production ordersPlanned production orders ) – Set this

option to YesYes  to add the calculated delay to the requirements.

Add the calculated delay to the requirement dateAdd the calculated delay to the requirement date (under Planned transferPlanned transfer ) – Set this option to YesYes

to add the calculated delay to the requirements.

Add the calculated delay to the requirement dateAdd the calculated delay to the requirement date (under Planned kanbanPlanned kanban) – Set this option to YesYes  to

add the calculated delay to the requirements.

When you set the Add the calculated delay to the requirement dateAdd the calculated delay to the requirement date options to YesYes  to add the delays to

the requirements, the system considers the capacity of the resources and creates feasible planned orders.

Recalculation of the planned order dates increases the running time for master planning. Therefore, if you don't

need to use the delays, set the options to NoNo.

Positive and negative days affect how master planning suggests planned orders and actions. Positive and

negative days are set on the item coverage group of the item. You can define the various coverage groups and

set their parameters on the Coverage groupsCoverage groups  page (Master planning > Setup > Coverage > CoverageMaster planning > Setup > Coverage > Coverage

groupsgroups).

Positive days indicate how far in the future master planning considers the current inventory or receipts to fulfill

a future demand. For example, if the positive days are set to 100100 , the current inventory can be used to fulfill

demand in the next 100 days. If there is an order 150 days from the current date, master planning will create a

planned order to satisfy that demand, even though the on-hand inventory for the item can satisfy the order. For

fast-moving items that have a short lead time, you might not want to use the on-hand inventory for an order

that is far in the future. In this fast-moving case, the current on-hand inventory will be gone quickly, and more
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orders could be placed in the future to fulfill a future demand on time, which would be possible due to the short

lead time of the item.

The positive days also affect the action messages. For example, the system might recommend that you increase

a planned purchase order so that it includes a demand that is within the number of positive days in the future. If

the positive days are set to 100100 , and if there is demand for an item in 30 days from the current date, the system

will create a planned order to satisfy that demand. If there is demand for the same item in 90 days from the

current date, the system will recommend that you increase the quantity of the order in 30 days from the current

date, so that the order also covers the demand in 90 days. However, if there is demand for the item in 150 days

from the current date, the system won't recommend that you increase the quantity of the order that was already

planned. Instead, a new planned order will be created.

As a rule, the positive days are set to a number that is between the longest lead time of the items and the

coverage time fence. We recommend that you assign items that are regularly procured or produced to a

coverage group where the positive days equal the item's lead time.

Negative days indicate how late item receipts will be allowed. They represent the number of days that you're

willing to wait before you order new replenishment when you have negative inventory or don't have enough

inventory. Negative days answer the question, Should we create a new purchase order for the item, or should

we use an existing purchase, even though we know that the item will be late?

For example, you have a sales order for an item 15 days from the current date. You also have a purchase order

for the same item. This purchase order will be received in 20 days from the current date. Do you want the

system to create a purchase order for that sales order, or do you want to use the existing order, even though you

can't fulfill the sales order on time? If the negative days are set to less than 55  to indicate the item can be delayed

a maximum of five days, the system creates a new planned purchase order to satisfy the sales order. If the

negative days are set to greater than 55 , the system uses the existing order for the item.

The negative days also affect the performance of master planning. If the negative days are set to a high number,

lots of action messages will be generated.

We recommend that you set the negative days to a number that is less than the lead time of the item.

Dynamic negative days consider the item's lead time and the negative days that you specified. The system will

create a new planned purchase order, based on the negative days time fence that is calculated by using the

following formula:

Lead time + Negative days + Current date – Requirement date

The system uses only the planned supply orders that are within this time fence, and it creates a new planned

order outside it. The advantage of dynamic negative days is that it will include the individual product lead time,

to reuse existing orders and avoid creating new planned orders that will end up with a later day, due to delays

caused by lead time.

For more information, see Negative days and dynamic negative days.

Can you tell us about your documentation language preferences? Take a short survey.
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Specific requirements of your company

Number of threadsNumber of threads

Bundle sizeBundle size

Firming bundle sizeFirming bundle size

Cache sizeCache size

Manufacturing setupManufacturing setup

This topic provides a guide for the Master planning setup wizardMaster planning setup wizard. It explains how parameter suggestions are

calculated and also provides examples that show how different companies set up master planning, based on

their business needs.

The Master planning setup wizard in Dynamics 365 Supply Chain Management video (shown above) is included

in the Finance and Operations playlist available on YouTube.

The first page of the wizard asks about the specific requirements of your company. Your answers to these

questions don't have to be exact, but you should be able to provide a rough approximation of the number of

items and planned orders that there will be for the legal entity. Your answers are used to configure parameters

that apply to your legal entity, not just to the master plan that you selected. The following sections describe the

parameters that are calculated and the formulas that are used.

If you manufacture any of the items:If you manufacture any of the items: Number of threads = Number of planned orders ÷ 1,000

If you don't manufacture any of the items:If you don't manufacture any of the items: Number of threads = Number of items ÷ 1,000

If the number of threads that is calculated exceeds 75 percent of the available number of threads, it's capped at

75 percent of the number of threads that is available for each customer. (The number of available threads will be

determined for each customer.)

For more information, see Number of threads.

The bundle size will be set to 11 . This value is often the best value, because it helps improve the performance of

master planning.

For more information, see Number of tasks in helper task bundle.

If you manufacture any of the items:If you manufacture any of the items: The firming bundle size will be set to the larger of these two values:

1010  and the bundle calculation

If you don't manufacture any of the items:If you don't manufacture any of the items: The firming bundle size will be set to the larger of these two

values: 5050  and the bundle calculation

Bundle calculation = (Number of planned orders × (Firming time fence ÷ Coverage time fence) ÷ Number of

threads) ÷ 10

The cache size will be set to MaximumMaximum. This value is often the best value, because it helps improve the

performance of master planning.

For more information, see Allocate time to jobs in a job bundle.

If you manufacture items, a Manufactur ing setupManufactur ing setup page will appear later in the wizard.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/master-planning-setup-wizard.md
https://www.microsoft.com/videoplayer/embed/RE3YnSB
https://youtu.be/c-e6n-8rZb4
https://www.youtube.com/playlist?list=PLcakwueIHoT_SYfIaPGoOhloFoCXiUSyW
https://docs.microsoft.com/en-us/dynamics365/unified-operations/supply-chain/master-planning/master-planning-performance#number-of-threads
https://docs.microsoft.com/en-us/dynamics365/unified-operations/supply-chain/master-planning/master-planning-performance#number-of-tasks-in-helper-task-bundle
https://docs.microsoft.com/en-us/dynamics365/unified-operations/supply-chain/production-control/allocate-time-jobs-job-bundle


Scope of the current plan

Scheduling options

Updates of demand and supply

On the Scope of the current planScope of the current plan page of the wizard, you answer questions that are related to how far in the

future various requirements will be considered and calculated in master planning. Each question asks whether

you want to use a feature and how you want to configure it.

For example, for the forecast plan feature, the wizard asks, "Do you want to use a forecast plan in master

planning so that planned orders will be suggested to fulfill the forecasted demand?"

The following options are available:

NoNo – Master planning won't suggest planned orders to fulfill a forecast. On the Time fencesTime fences  tab of the

Master plansMaster plans  page (Master planning > Setup > Plans > Master plansMaster planning > Setup > Plans > Master plans ), the wizard will set the

Forecast plan (time fence)Forecast plan (time fence)  option to YesYes  and set the number of days to 00  (zero). This setup will override

the time fence that is specified in the coverage group. Because the number of days is set to 00  (zero), the

feature won't be used.

Yes, as defined in this master planYes, as defined in this master plan – A field becomes available, where you can enter the number of days

that master planning will suggest planned orders to fulfill the forecasted demand. The wizard will set the

Forecast plan (time fence)Forecast plan (time fence)  option to YesYes  and set the number of days to the number of days that is entered

in the Forecast planForecast plan field on the Time fencesTime fences  tab of the Master plansMaster plans  page. This setup will override the

values that are set in the coverage groups.

Yes, as defined in the coverageYes, as defined in the coverage – The wizard will set the Forecast plan (time fence)Forecast plan (time fence)  option to NoNo. The

time fences that are specified in the coverage group will be used to specify how long you will plan for the

forecast.

The remaining questions on this page and their answers follow the same schema:

NoNo – The Forecast plan (time fence)Forecast plan (time fence)  option will be set to YesYes , and the number of days will be set to 00

(zero).

Yes, as defined in this master planYes, as defined in this master plan – The Forecast plan (time fence)Forecast plan (time fence)  option will be set to YesYes . The

number of days that you enter will be used and will override the values that are set in the coverage groups.

Yes, as defined in the coverage groupYes, as defined in the coverage group – The Forecast plan (time fence)Forecast plan (time fence)  option will be set to NoNo.

For more information, see Job scheduling.

The Scheduling optionsScheduling options  page appears only if you answered YesYes  to the "Do you manufacture any of the items

planned?" question on the first page of the wizard.

Your answer to the first question on this page ("Do you need to schedule operations divided into individual

jobs?") determines the scheduling method on the GeneralGeneral  tab of the Master plansMaster plans  page.

YesYes  – Job scheduling will be used.

NoNo – Operations scheduling will be used.

For more information, see Operations scheduling and Job scheduling.

The questions on the Updates of demand and supplyUpdates of demand and supply  page are related to firming, action messages, and

delays.

The master planning setup will be updated based on your answers, according to the same schema that is

described in the previous section:

https://docs.microsoft.com/en-us/dynamics365/unified-operations/supply-chain/production-control/job-scheduling
https://docs.microsoft.com/en-us/dynamics365/unified-operations/supply-chain/production-control/operations-scheduling
https://docs.microsoft.com/en-us/dynamics365/unified-operations/supply-chain/production-control/job-scheduling


Summary of your changes

Examples

Example 1: Contoso ManufacturerExample 1: Contoso Manufacturer

NoNo – The Time fenceTime fence option on the Master plansMaster plans  page will be set to YesYes , and the number of days will be

set to 00  (zero).

Yes, as defined in this master planYes, as defined in this master plan – The Time fenceTime fence option will be set to YesYes . The number of days that

you enter will be used and will override the values that are set in the coverage groups.

Yes, as defined in the coverage groupYes, as defined in the coverage group – the Time fenceTime fence option will be set to NoNo.

For calculated delays, your answers to the questions in the wizard will update the corresponding parameters on

the Calculated delaysCalculated delays  tab of the Master plansMaster plans  page.

The last page of the wizard shows the changes that that are recommended based on your responses. It shows

both the value in your setup (Current setupCurrent setup) and the value that the wizard recommends (NewNew

configurationconfiguration).

You can also modify the parameters in the new configuration. The parameters are separated into parameters

that apply to your legal entity and parameters that apply only to the master plan that you selected. To view all

the setup parameters that can be changed by using the wizard, select Show all parametersShow all parameters  at the bottom of

the page. You can then change the parameters.

Finally, when you select FinishFinish , the new configuration is applied. If you select CancelCancel , none of the changes are

applied.

This section describes the setup of two fictional companies to show how the setup can change according to the

needs of each business.

Contoso Manufacturer is a manufacturing company that produces speakers. It purchases the various raw

materials and components that are used for the final speakers from various suppliers. Here are some of the

characteristics of its supply and manufacturing:

The final items that the company manufactures have a bill of materials (BOM) structure.

All final items and components are planned by master planning. Manual planning isn't done.

A route of operations is defined for the production of each final item.

The manufacturing plant produces the final items. It has a defined number of milling and drilling machines

that are used to process the components. The various components must be processed by these machines.

There are many suppliers. The average lead time for items is one week. A group of items from the same

supplier will have a lead time of seven weeks.

In the wizard, the following values are entered for Contoso Manufacturer :

Coverage:Coverage:

Question:Question: "Do you want to specify the number of days of your planning horizon?"

Answer :Answer : "Yes, as defined in the coverage groups."

Because the lead time for items is very different, Contoso doesn't have to plan all the items for the same

period in the future. Coverage groups for the items are created. Items that have a similar lead time are

assigned to the same coverage group. The planning horizon for each coverage group (that is, the

coverage time fence) is approximately the lead time plus a margin of one week. Master planning then

makes sure that the items are planned in advance, based on their lead time.

Therefore, two coverage groups will be created for this example. One coverage group will have a

coverage time fence of two weeks, and the other will have a coverage time fence of eight weeks.



Example 2: Contoso RetailerExample 2: Contoso Retailer

If Yes, as defined in this master planYes, as defined in this master plan is selected as the answer, the number of days that is entered

should exceed the longest lead time of all the items. However, because many items don't have to be

planned so far in advance, many planned orders will be calculated but never used. Therefore, the master

planning runtime will increase.

Scheduling:Scheduling:

Question:Question: "Do you need to schedule operations divided into individual jobs?"

Answer :Answer : "Yes."

Contoso Manufacturing must plan and schedule the individual jobs that will be performed on the shop

floor. Therefore, it will use job scheduling.

Capacity:Capacity:

Question:Question: "Do you want to schedule using the capacity of resources?"

Answer :Answer : "Yes, as defined in this master plan." 10 days10 days  is entered.

The number of milling and drilling machines is limited. Production planning must take this limitation into

account and arrange the jobs in time according to the capacity of the resources. In other words, the jobs

that are scheduled will be replanned based on the limitations of the resources. Planning will use the lead

time in addition to the period that is defined. (Planned production orders can overlap.) Because the

production lead time for the items is seven days, the capacity of the resources for master planning will be

considered during 10 days.

Sequencing:Sequencing:

Question:Question: "Do you want to sequence planned orders using the product's sequence values?"

Answer :Answer : "Yes, as defined in the coverage groups."

A route is defined for the production of each final item. Therefore, master planning will schedule the

orders in time according to the defined routes.

Explosion:Explosion:

Question:Question: "Do you want to plan orders for all the elements in a Bill of Materials (plan for the parent

and all children items)?"

Answer :Answer : "Yes, as defined in the coverage groups."

All the items that are used for the production must be planned. Because the items have very different

lead times, master planning will have better performance when it uses the coverage groups. Again, a

margin of one week can be entered, and explosion can be done for the same time as the coverage.

Contoso Retailer is a distribution company in the fashion industry. It uses master planning to calculate when

purchase orders should be placed, based on its forecasted sales. Here are some of its characteristics:

Contoso Retailer uses a demand forecast to predict sales. Purchase orders will be planned according to the

forecast.

Stores use requisitions for replenishment.

The lead time from the main warehouse to each store is approximately two weeks for all items.

In the wizard, the following values are entered for Contoso Retailer :

Forecast demand:Forecast demand:

Question:Question: "Do you want to use a forecast plan in master planning so that planned orders will be

suggested to fulfill the forecasted demand?"

Answer :Answer : "Yes, as defined in this master plan."

Contoso has included a demand forecast to predict its sales. Therefore, master planning must
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recommend planned orders to fulfill the forecast.

Firming:Firming:

Question:Question: "Do you want master planning to automatically firm planned orders into order documents,

for example production or purchase orders?"

Answer :Answer : "Yes, as defined in this master plan." 1 day1 day  is entered.

Because Contoso Retailer will create purchase orders directly from the planned purchase orders, it's

useful if the planned purchase orders are automatically firmed. Because the company runs master

planning every day, a firming time fence of one day will automatically firm all the orders that are required

for the next day.

Approved requisitions:Approved requisitions:

Question:Question: "Do you want to include demand from approved requisitions to replenish retail stores?"

Answer :Answer : "Yes, as defined in this master plan." 1 day1 day  is entered.

Contoso uses the approved requisitions from its stores to create planned purchase orders to replenish

those stores. Because master planning is run every day, the requisitions from the last day will be included

in the planning.
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Coverage codes

Master scheduling uses coverage settings to calculate item requirements.

You can specify coverage settings in several ways:

Specify coverage settings for a coverage group.

You can create a coverage group that contains settings for all products that are linked to the coverage

group. To create a coverage group, go to Master planning > Setup > Coverage > CoverageMaster planning > Setup > Coverage > Coverage

groupsgroups . You can link a coverage group to a product. If the link is specific to a site, warehouse, or product

dimension, use the Coverage groupCoverage group field on the Item coverageItem coverage page. If the link is generic, regardless

of the product dimensions, use the Coverage groupCoverage group field on the PlanPlan FastTab of the Product detailsProduct details

page. By default, if you don't link a coverage group to a product, master planning uses the general

coverage group that is specified on the Master planning parametersMaster planning parameters  page.

Specify coverage settings for a product.

You can create coverage settings for a specific product. Go to Product information management >Product information management >

Products > Released productsProducts > Released products . Select the product, and then, on the Action Pane, on the PlanPlan tab, in

the CoverageCoverage group, select Item coverageItem coverage to open the Item coverageItem coverage page. If the product is already

linked to a coverage group, you can override the coverage group settings by using the Overr ideOverr ide field.

The coverage settings on the Item coverageItem coverage page take precedence over the settings on the CoverageCoverage

groupgroup page.

Specify coverage settings for a product by using a wizard.

The wizard guides you step by step through the process of setting up the primary item coverage

parameters. On the Item coverageItem coverage page, on the Action Pane, select WizardWizard to open the Item CoverageItem Coverage

WizardWizard.

Specify coverage settings for a dimension group.

Go to Product information management > Products > Released productsProduct information management > Products > Released products . On the ReleasedReleased

product detailsproduct details  page, on the GeneralGeneral  FastTab, in the AdministrationAdministration section, select the link in the

Storage dimension groupStorage dimension group field. On the Storage dimension groupsStorage dimension groups  page, select the Coverage planCoverage plan

by dimensionby dimension check box to create the coverage settings for a dimension in the storage dimension

group. The Coverage plan by dimensionCoverage plan by dimension field must be selected for all product dimensions, such as

configuration, color, size, and style.

Master planning can be configured to use different replenishment methods. The replenishment methods or lot-

sizing methods are the techniques used by the system to determine the batch size for purchased or produced

items.

Each replenishment method is assigned one of the following coverage codes:

ManualManual  - The lot-sizing method where the system does not suggest purchased, transfer, or production

orders for the item. The planner for the item will be in charge of creating the required orders for the

replenishment of the item.

Per requirementPer requirement - The lot-sizing method in which the system creates a planned purchase, transfer, or
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production order per requirement for the item. This is generally used for expensive items with intermittent

demand.

Per per iodPer period - The lot-sizing method that combines all the demand for a period into one order for the item.

The order will be planned for the first day of the period and its quantity will fulfill the net requirements

during the established period. The period starts with the first demand of the item and covers the defined

length in time. The next period will start with the next requirements of the item.

Min/MaxMin/Max - The lot-sizing method that contains the replenishment of inventory up to a certain level when the

predicted on-hand is below a threshold. The replenishment quantity will be the difference between the

maximum level and the predicted on-hand level.

Master plans overview

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a coverage group

Create a new product

The demo data company used to create this procedure is USMF. This procedure shows how to create coverage

rules and override coverage settings for a specific item. It also shows how to specify default inventory settings.

1. Go to Navigation pane > Modules > Master planning > Setup > Coverage groupsNavigation pane > Modules > Master planning > Setup > Coverage groups .

2. Click NewNew .

3. In the Coverage groupCoverage group field, type a value.

4. In the NameName field, type a value.

5. In the CalendarCalendar  field, type a value. Choose the calendar that master planning uses to create replenishment

suggestions for items in this group.

6. In the Coverage codeCoverage code field, select an option. Select 'Requirement' for this procedure.

7. In the Coverage time fence (days) fieldCoverage time fence (days) field, enter '90'. For items in this group, master planning will create

replenishment suggestions for up to 90 days in the future.

8. In the Negative daysNegative days  field, enter '1'.

9. In the Positive daysPositive days  field, enter '1'.

10. Expand or collapse the OtherOther  section.

11. Under the Safety margins in daysSafety margins in days  section, in the Receipt margin added to requirement dateReceipt margin added to requirement date field,

enter '1'. For example, if the receipt margin is set to 1 day, and a purchase order line is scheduled for receipt

on May 15, master planning calculates the adjusted receipt date as May 16.

12. In the Issue margin deducted from requirement dateIssue margin deducted from requirement date field, enter '1'. For example, if the safety margin is

set to 1 day, and a sales order line is scheduled for delivery on May 15, master scheduling calculates the

adjusted delivery date as May 14.

13. In the Reorder margin added to item lead timeReorder margin added to item lead time field, enter '1'.

14. Click SaveSave.

1. Go to Navigation pane > Modules > Product information management > Products > ReleasedNavigation pane > Modules > Product information management > Products > Released

productsproducts .

2. Click NewNew .

3. In the Product numberProduct number  field, type a value.

4. In the Product nameProduct name field, type a value.

5. In the Item model groupItem model group field, click the drop-down button to open the lookup.

6. In the list, find and select the desired record.

7. In the list, click the link in the selected row.

8. In the Item groupItem group field, click the drop-down button to open the lookup.

9. In the list, find and select the desired record.

10. In the list, click the link in the selected row.

11. In the Storage dimension groupStorage dimension group field, click the drop-down button to open the lookup.

12. In the list, find and select the desired record.

13. In the list, click the link in the selected row.

14. In the Tracking dimension groupTracking dimension group field, click the drop-down button to open the lookup.
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Setup default order settings

Add an item to a coverage group

Create item coverage rules

15. In the list, find and select the desired record.

16. In the list, click the link in the selected row.

17. Click OKOK.

1. On the Action PaneAction Pane, click PlanPlan.

2. Under Order settingsOrder settings , click Default order settingsDefault order settings .

3. Under Purchase orderPurchase order , in the Default siteDefault site field, type the site used as default when purchase orders are

created.

4. In the Default warehouseDefault warehouse field, type the site where the item is stored.

5. Expand or collapse the Inventor yInventor y  section.

6. In the MultipleMultiple field, type '10'.

7. In the Min. order quantityMin. order quantity  field, type '10'.

8. In the Max. order quantityMax. order quantity  field, type '100'.

9. In the Standard order quantityStandard order quantity , type '10'.

10. In the Purchase lead timePurchase lead time field, enter a number.

11. Select or clear the Working daysWorking days  check box.

12. Click SaveSave.

13. In the Default order typeDefault order type field select 'Purchase order'.

14. Click SaveSave.

15. Close the page. Close the Default order settings page.

1. Expand or collapse the PlanPlan section.

2. In the Coverage groupCoverage group field, click the drop-down button to open the lookup.

3. In the list, find the Coverage groupCoverage group you have created.

4. In the list, click the link in the selected row.

1. On the Action PaneAction Pane, click PlanPlan.

2. Under CoverageCoverage, click Item coverageItem coverage.

3. Click NewNew .

4. Click the GeneralGeneral  tab.

5. Check the box on the header of Overr ide coverage groupOverr ide coverage group settings.

6. In the Coverage time fence (days)Coverage time fence (days)  field, enter '60'. Although items in coverage group Requiremen are

planned 90 days ahead, this item will be planned 60 days ahead.

7. In the Negative daysNegative days  field, enter '2'.

8. In the Positive daysPositive days  field, enter '2'.

9. Click the Lead timeLead time tab.

10. Check the box on the header of PurchasePurchase.

11. In the Purchase timePurchase time field, enter '5'.

12. Click SaveSave.
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Set up a constrained plan

Create a constrained plan

NOTENOTE

This topic explains how to create a plan that takes into account both material and capacity constraints. The plan

ensures that manufacturing doesn't start before materials are available and resources are not overbooked.

The demo data company used to create this procedure is USMF. This procedure is intended for the production

planner.

1. In the home page, select the Master planningMaster planning workspace.

2. Select Master plansMaster plans  in the list of links on the far right side of the workspace.

3. In the list, find and select the desired record. Example: StaticPlanStaticPlan

4. Select YesYes  in the Finite capacityFinite capacity  field.

5. In the Finite capacity time fenceFinite capacity time fence field, enter 30 .

6. Expand the Time fences in daysTime fences in days  section.

7. Select YesYes  in the CapacityCapacity  field.

8. In the Capacity scheduling time fence (days)Capacity scheduling time fence (days)  field, enter a number. Example: 60

9. Select YesYes  in the Calculated delaysCalculated delays  field.

10. In the Calculate delays time fence (days)Calculate delays time fence (days)  field, enter a number. Example: 60

11. Expand the Calculated delaysCalculated delays  section.

12. Select YesYes  in all Add the calculated delay to the requirement dateAdd the calculated delay to the requirement date fields.

13. Close the page.

1. Select RunRun.

2. In the Master planMaster plan field, enter or select the plan for which you have set up constraints.

3. Select OKOK.

4. Select Planned ordersPlanned orders .

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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2/18/2021 • 2 minutes to read • Edit Online

Create requirement for a co-product

Create a material plan for co-products

The production planner plans the material requirements for items that are formula co-products. The demo data

company used to create this procedure is USP2.

1. Go to Default dashboard.

2. Click Sales order processing and inquiry.

3. Click New.

4. Click Sales order.

5. In the Customer account field, type a value.

6. Click OK.

7. In the Item number field, type a value.

8. In the Quantity field, enter a number.

9. Click Save.

Example: US-001

Example: P6003

Example: 50000

1. Close the page.

2. Close the page.

3. Click Master planning.

4. In the Plan field, click the drop-down button to open the lookup.

5. In the list, click the link in the selected row.

6. Click Run.

7. Expand or collapse the Records to include section.

8. Click Filter.

9. In the list, select the row for Field = Item number.

10. In the Criteria field, type a value.

11. Click OK.

12. Click OK.

13. Click Planned orders.

14. Use the Quick Filter to find records. For example, filter on the Item number field with a value of 'P6000'.

15. In the list, mark the selected row.

16. In the list, click the link in the selected row.

17. Expand or collapse the Pegging section.

18. In the list, click the link in the selected row.

Example: MasterPlan

Example: P6003

Filter by the formula item that has as co-product of the item that you created a sales order for.

Select any of the rows returned by the filter.
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Create requirement for a co-product

Create a material plan for co-products

19. Close the page.

The planned order is pegged to the sales order for the co-product.

1. Go to Default dashboard.

2. Click Sales order processing and inquiry.

3. Click New.

4. Click Sales order.

5. In the Customer account field, type a value.

6. Click OK.

7. In the Item number field, type a value.

8. In the Quantity field, enter a number.

9. Click Save.

Example: US-001

Example: P6003

Example: 50000

1. In the Plan field, click the drop-down button to open the lookup.

2. In the list, click the link in the selected row.

3. Click Run.

4. Expand or collapse the Records to include section.

5. Click Filter.

6. In the list, select the row for Field = Item number.

7. In the Criteria field, type a value.

8. Click OK.

9. Click OK.

10. Click Planned orders.

11. Use the Quick Filter to find records. For example, filter on the Item number field with a value of 'P6000'.

12. In the list, mark the selected row.

13. In the list, click the link in the selected row.

14. Expand or collapse the Pegging section.

15. In the list, click the link in the selected row.

16. Close the page.

17. Click Master planning.

18. Go to Master planning > Setup > Master planning parameters.

19. Select No in the Disable all planning processes field.

20. Close the page.

Example: MasterPlan

Example: P6003

Filter by the formula item that has as co-product of the item that you created a sales order for.

Select any of the rows returned by the filter.

The planned order is pegged to the sales order for the co-product.
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Planned order status

Firming planned orders

NOTENOTE

Parallelize firming

This topic provides information about how to manage planned orders. It describes how you can update the

status of planned orders, firm them, and filter for planned orders that have the same status as a selected

planned order.

You can manage planned orders from the Master planningMaster planning workspace, the Planned orderPlanned order  list, or the

Planned production ordersPlanned production orders , Planned purchase ordersPlanned purchase orders , and Planned transferPlanned transfer  lists.

You can use the StatusStatus  field to help track your progress. The following values are used:

When master planning generates planned orders, the planned orders have a status of UnprocessedUnprocessed.

If you decide not to firm a planned order, you can give it a status of CompletedCompleted.

If you want to firm a planned order, you can change the status to ApprovedApproved. Planned orders with ApprovedApproved

status are respected by master planning, so they are not modified or deleted during a later master planning

run. To achieve this, the planning logic copies the ApprovedApproved planned orders from the old plan version to the

new plan version during master planning.

By firming planned orders, real orders are created. These are also known as released or open orders. When a

planned order is firmed, it's moved to the orders section of the relevant module.

You can select two firming options from the Planned ordersPlanned orders  page:

FirmFirm – This will firm one or multiple selected planned orders.

Firm allFirm all  – This will firm all planned orders in the filter. Using Firm allFirm all  you don’t have to select the planned

order, all planned orders within the filter will be firmed. This option can be useful if you are firming a high

number of planned orders.

You can track a planned order that was firmed from Firming histor yFirming histor y  under Planned orders form > View > FirmingPlanned orders form > View > Firming

histor yhistor y .

If you are planning to firm many orders at the same time, parallelizing the run can improve the run time or

performance. This option is available when firming multiple planned orders with either FirmFirm or Firm allFirm all . The

following parameters are available:

Parallelize firmingParallelize firming – If YesYes , the firming process will be parallelized with the number of threads defined in

Number of threadsNumber of threads .

Number of threadsNumber of threads  – Controls the number of threads used to parallelize the firming process. The

parameter is only shown when Parallelize firmingParallelize firming is set to YesYes .
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The option for Parallelize firmingParallelize firming is only shown when you have more than one planned order selected for firming.

Master plans overview

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Set up safety stock levels for items

NOTENOTE

Example: Minimum key

L IN EL IN E EN T ER T H IS VA L UEEN T ER T H IS VA L UE RESULTRESULT

1-3 1 Minimum inventory is based on the
setting for January through March on
the Item coverageItem coverage page.

Safety stock indicates an additional quantity of an item held in the inventory in order to reduce the risk that the

item will be out of stock. Safety stock is used as a buffer stock in case sales orders come in and the supplier is

unable to deliver the additional items to meet the customer's requested ship date. When safety stock is used to

fulfill a sales order, the safety stock will be reduced. You can use Master planning to automatically bring the

inventory back to the safety level.

Safety stock is set up as part of item coverage on the Item coverageItem coverage page under Released productsReleased products  > PlanPlan

> CoverageCoverage.

In the MinimumMinimum field, enter the safety stock level that you want to maintain for the item. The value is expressed

in inventory units. If you leave the field blank, the default value is zero. This field is available when you select

PeriodPeriod, RequirementRequirement, or Min/MaxMin/Max in the Coverage codeCoverage code list. The stock level limit applies to the available

inventory, which means that reservations and markings may trigger safety stock replenishment before the

physical quantity goes below the specified minimum level.

You must define all other planned coverage dimensions before you can define the MinimumMinimum field. This prevents an

invalid record from being used during master planning. This situation can occur if, for example, a dimension group is

extended with an additional planned coverage dimension for which the minimum and maximum inventory quantities are

not yet defined.

You can use minimum keys to handle seasonal fluctuations in demand. For example, you can decrease the

minimum inventory level for an item in the off-season, and then gradually increase the level during the other

months. You create a minimum key by going to Master planningMaster planning > SetupSetup > CoverageCoverage >

Minimum/maximum keysMinimum/maximum keys . You specify the minimum key to adjust the safety stock level by seasonality in the

Minimum keyMinimum key  field on the Item coverageItem coverage page.

If you want to set up a minimum key that accounts for increased seasonal demand during the spring and

summer months, go to Master planningMaster planning > SetupSetup > CoverageCoverage > Minimum/maximum keysMinimum/maximum keys  and follow

these steps.

1. Create 12 lines and assign a number from 1 to 12 to the lines in the ChangeChange field.

2. In the UnitUnit field, select MonthsMonths .

3. In the FactorFactor  field, enter the values that are described in the following table.
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4-5 2 Minimum inventory is multiplied by a
factor of 2 for April through May.

6-8 2.5 Minimum inventory is multiplied by a
factor of 2.5 for June through August.

9-12 1 Minimum inventory reverts to the
setting for September through
December on the Item coverageItem coverage
page.

L IN EL IN E EN T ER T H IS VA L UEEN T ER T H IS VA L UE RESULTRESULT

Example: Min/Max coverage code

Safety stock fulfillment

NOTENOTE

If the coverage code is Min/MaxMin/Max, you can also specify the MaximumMaximum inventory quantity that you want to

maintain for the item. The value is also expressed in inventory units. If the projected available inventory falls

below the minimum quantity, master planning generates a planned order to fulfill all open requirements and

brings the available inventory up to the specified maximum quantity. Just like you set up MinimumMinimum, you must

define all other planned coverage dimensions before you can define the MaximumMaximum field.

The minimum quantity is 10, and the maximum quantity is 15. Current on-hand inventory is 4. This gives a

minimum quantity requirement of 6. However, because the maximum quantity is 15, master planning generates

a planned order for 11 items.

For items that follow seasonal demands, you may need to maintain different maximum levels. To do that, you

need to define Maximum keysMaximum keys  by going to Master planningMaster planning > SetupSetup > CoverageCoverage > Minimum/maximumMinimum/maximum

keyskeys . Fill in the Maximum keyMaximum key  field on the Item coverageItem coverage page. You can view the information about the

safety stock levels, defined via minimum keys on the Min/MaxMin/Max tab, on the Item coverageItem coverage page. You need to

make sure that, for a certain period, the minimum and the maximum values are kept in sync.

The Fulfill minimumFulfill minimum parameter allows you to select the date or the period during which the inventory level

must meet the quantity that you specified in the MinimumMinimum field. This field is available when you select Per iodPeriod,

RequirementRequirement, or Min/MaxMin/Max in the Coverage codeCoverage code list.

If Minimum keysMinimum keys  are used, select the Minimum periodsMinimum periods  check box to fulfill the minimum inventory level for

all the periods that are set up in the minimum key. If you clear the check box, the minimum inventory is fulfilled

for the current period only.

The following scenario shows how this parameter works and what are the differences between its values.

For all the illustrations in this topic, the x-axis represents inventory, the y-axis represents days, the bars represent the

inventory level, the arrows represent transactions, such as sales order lines, purchase order lines, or planned orders.



Today's dateToday's date

The Fulfill minimumFulfill minimum parameter can have the following values:

The specified minimum quantity is met on the date when master planning is run. The system tries to fulfill the

safety stock limit as soon as possible, even though it can be unrealistic due to the lead time. 

Planned order P1 is created for today's date to bring the available inventory above the safety stock level on this

date. The sales order lines S1 to S3 continue to lower the inventory level. Planned orders P2 to P4 are generated

by master planning so that the inventory level is brought back to the safety limit after each sales order

requirement. When the RequirementRequirement coverage code is used, multiple planned orders are created. It is always a

good idea to use either Per iodPeriod or Min/MaxMin/Max coverage for items and materials in frequent demand, to bundle

the replenishment. The following illustration shows an example for coverage code PeriodPeriod. 
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file:///T:/eiye/ac1a/dynamics365/supply-chain/master-planning/media/todayreq.png


Today's date + procurement timeToday's date + procurement time

The following illustration shows an example for coverage code Min/MaxMin/Max. 

The specified minimum quantity is met on the date when master planning is run, plus the purchase or

production lead time. This time includes any safety margins. If the item carries a trade agreement, and the FindFind

trade agreementstrade agreements  check box is selected on the Master planning parametersMaster planning parameters  page, the delivery lead time

from the trade agreement is not considered. Lead times are taken from the item's coverage settings or from the

item. This fulfillment mode will create plans with less delays and fewer planned orders regardless of the

coverage group set up on the item. The following illustration shows the outcome of the plan if the coverage

code is RequirementRequirement or Per iodPeriod.
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First issueFirst issue

The following illustration shows the outcome of the plan if the coverage code is Min/MaxMin/Max.

The specified minimum quantity is met on the date when the available inventory goes below the minimum level,

as shown in the following illustration. Even if the available inventory is below the minimum level on the date

when master planning is run, First issueFirst issue will not attempt to cover it until the next requirement comes in. The

following illustration shows an example for coverage code RequirementRequirement. 
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The following illustration shows an example for coverage code PeriodPeriod. 

The following illustration shows an example for coverage code Min/MaxMin/Max. 
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On the date when master planning is run, if the available inventory is already under the safety stock limit,

Today's dateToday's date and Today's date + procurement timeToday's date + procurement time will trigger the replenishment immediately. First issueFirst issue

will wait until there is another issue transaction, such as sales order and BOM line requirement, for the item, and

then it will trigger the replenishment on the date of this transaction. On the date when master planning is run, if

the available inventory is not under the safety stock limit, Today's dateToday's date and First issueFirst issue will provide exactly the

same result, as shown in the illustration below.

On the date when master planning is run,if the available inventory is not under the safety stock limit, Today'sToday's

date + procurement timedate + procurement time will provide the following result, because it postpones the fulfillment until the end

of the procurement lead time. 
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Coverage time fenceCoverage time fence

Plan safety stock replenishment for First Expired, First Out (FEFO)
items

The specified minimum quantity is met during the period that is specified in the Coverage time fenceCoverage time fence field.

This option is useful when master planning does not allow available inventory to be used for real orders, such as

sales or transfers, in the attempt to maintain the safety level. However, in a future release, this mode of

replenishment will no longer be needed, and this option will be deprecated.

At any point in time, the inventory receipt with the latest expiry date will be used for safety stock to allow real

demand, such as sale lines or BOM lines, to be fulfilled in the FEFO (First Expired, First Out) order. To show how

this works, consider the following scenario. 

When planning is run, it will cover the first sales order from the existing on-hand inventory and an additional

purchase order, for the remaining quantity. 

file:///T:/eiye/ac1a/dynamics365/supply-chain/master-planning/media/fefoscenario.png


A planned order is created to make sure that the available inventory is brought back to the safety limit. 

When the second sales order is planned, the previously created planned order that covers the safety stock is

used to cover this quantity. Hence, the safety stock is constantly rolling. 

file:///T:/eiye/ac1a/dynamics365/supply-chain/master-planning/media/fefo1.png
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How master planning handles the safety stock constraint

Finally, another planned order is created to cover the safety stock. 

All the batches are expire accordingly, and planned orders are created to refill the safety stock after it has

expired.

Safety stock is tracked in the system as a requirement type, just like sales lines or BOM requirements. You can

see the safety stock requirement line on the Net requirementsNet requirements  page if you remove the default filter on the

Requirement typeRequirement type column.

Fulfilling the safety stock requirement transaction is deprioritized if the system determines that this causes

delays in the fulfillment of real demand, such as sales lines, BOM lines, transfer requirements, or demand

forecast lines. Otherwise, making sure that the available inventory is above the safety stock quantity has the

same priority as any other demand types. This ensures no delays for real transactions and helps to prevent over-

replenishment and early-replenishment of safety stock.

During the coverage phase of master planning, safety stock replenishment is no longer deprioritized. On-hand

inventory can be used before any other demand types. During the delay calculation, new logic will be added to

file:///T:/eiye/ac1a/dynamics365/supply-chain/master-planning/media/fefo3.png
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NOTENOTE

go over the delayed sales lines, BOM line requirements, and all the other demand types, to determine whether

they could be delivered on time, provided that the safety stock is used. If the system identifies that it can

minimize delays by using safety stock, then the sales lines or BOM lines will replace their initial coverage with

the safety stock, and the system will trigger the replenishment for the safety stock instead.

If the plan or the item is not set up for delayed calculation, then the safety stock constraint will have the same

priority as any other demand types. This means there is a reserve of on-hand and other available inventory

before other demand types.

Can you tell us about your documentation language preferences? Take a short survey.
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NOTENOTE

Limited delays in production setup with multiple BOM levels

Desired date

This topic provides information about delayed dates in master planning. A delayed date is a realistic due date

that a transaction receives if the earliest fulfillment date that master planning calculates is later than the

requested date.

Master planning can calculate the earliest fulfillment date for a transaction, based on lead times, material

availability, capacity availability, and various planning parameters.

If master planning calculates an order date that precedes the current date, the order can't be fulfilled on time.

Therefore, the order is delayed. In this case, master planning forward-plans the order from the current date and

includes lead times. These lead times start with any lower-level component items. The order then receives a

delayed date. A delayed date is a realistic due date, based on the current data. Master planning also calculates

the number of delay days.

In some situations, you might choose not to calculate delays, such as when users know that they can expedite

lead times by selecting alternative modes of delivery.

You can configure how delays are calculated for a coverage group. You can then attach the coverage group to an

item later.

On the Master planning parametersMaster planning parameters  page, you can set the start time for the calculation of delays. If an order

is fulfilled after this time, a delay of one day is added to the delay date of the order.

In earlier versions, calculated delays were known as futures messages, the delayed date was known as the futures date,

and a delayed transaction was referred to as a transaction that was future set.

When you work with delays in a production setup that has multiple BOM levels, it is important to note that only

the items directly above the item (in the BOM structure) causing the delay, will be updated with a delay as part

of the master planning run. Other items in the BOM structure will not get the delay applied until the first master

planning run, when the planned order for the top level is approved or firmed.

To work around this known limitation, the production orders on the top of the BOM structure with delays can be

approved (or firmed) prior to the next master planning run. This way the delay from the delayed approved

planned production order will be kept and all underlying components will be updated accordingly. Action

messages can also be used to identify planned orders that can be moved to a later date, due to other delays in

the BOM structure.

On the Planned orderPlanned order  page, under the DelaysDelays  tab is the Desired dateDesired date for the planned order. The desired date

of a planned order is the base date for delays, which is a computed date that equals the Requested dateRequested date

calculated from the Net RequirementNet Requirement. If the planned order is a BOM line, production line or kanban line, the

desired date is based on the Requirement dateRequirement date and the desired date will not be shown on the Planned orderPlanned order

page.
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Coverage settings
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Preferred cancel option
Cancel master planning job from Cancel master planning job from Unfinished planning processesUnfinished planning processes page page

Additional cancel options

Delete master planning job from the Delete master planning job from the Batch jobsBatch jobs page page

Abort master planning job task from the Abort master planning job task from the Batch jobs enhancedBatch jobs enhanced page page

NOTENOTE

In Microsoft Dynamics 365 Supply Chain Management, there are multiple options for canceling a master

planning job. For example, you may want to cancel a master planning job if it was started by mistake or is

running longer than expected and you want to end it. The best way to cancel a planning job is from the

Unfinished planning processesUnfinished planning processes  page. Alternative options from the Batch jobsBatch jobs  and Batch jobs enhancedBatch jobs enhanced

pages should only be used if canceling the master planning job from the Unfinished planning processesUnfinished planning processes

page did not complete within a few minutes.

1. Go to Master planning > Inquir ies and repor ts > Master planning > Unfinished planningMaster planning > Inquir ies and repor ts > Master planning > Unfinished planning

processesprocesses .

2. Select the line with the planning process that you want to cancel.

3. Click CancelCancel .

These should only be used if canceling the master planning job from the Unfinished planning processesUnfinished planning processes

page did not complete within a few minutes.

1. Go to System administration > Inquir ies > Batch jobsSystem administration > Inquir ies > Batch jobs .

2. Select the line with the planning job that you want to delete.

3. Click DeleteDelete.

1. Go to System administration > Inquir ies > Batch jobsSystem administration > Inquir ies > Batch jobs .

2. If the job ID is not shown in the list, click Switch to enhanced formSwitch to enhanced form , otherwise proceed with the next step.

3. Open the batch job. Click the Job IDJob ID for the batch job with tasks that you want to end.

4. In Batch tasksBatch tasks , select the tasks to end.

5. Click Change statusChange status , choose CancelingCanceling and click OKOK.

6. On the Batch tasksBatch tasks  FastTab, click Abor tAbor t.
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Additional resources

NOTENOTE

This article explains how you can use tracing to explore the causes behind the outcome of an order explosion.

By enabling tracing, you can view information about the factors that contributed to the outcome of the explosion

of a particular order. The following examples show how you can use the tracing information:

View relations between the actions on planned orders to optimize the supply chain and inventory

reservations.

View relations to orders that are already approved. You can focus on automatically firming derived

requirements and then prioritize orders more accurately.

Simulate planning results to determine whether the planning parameters are optimal.

Identify how information such as production dates, quantities, and priorities for an order were determined.

You can view details about futures and actions for a selected order. On the ExplosionExplosion page, tracing information

is available on the ExplanationExplanation tab in the upper pane. Tracing occurs when you explode an order. To start

tracing for the order, click UpdateUpdate, and then select the Enable traceEnable trace check box. You can use the Find textFind text field

to search the log for specific information. Search results are highlighted in the tree.

Master plans overview
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Introduction

Select action messages

M ESSA GEM ESSA GE DESC RIP T IO NDESC RIP T IO N

AdvanceAdvance If you select this message, the system will generate action
messages, when needed, to move orders to an earlier date.
In the Advance marginAdvance margin field, you can also specify the
maximum number of days between receipt and issue
without advance action.

PostponePostpone If you select this message, the system will generate action
messages, when needed, to move orders to a later date. In
the Postpone marginPostpone margin field, you can specify the maximum
number of days between receipt and issue without postpone
action.

DecreaseDecrease If you select this message, production orders, purchase
orders, and other receipt transactions should be decreased
to prevent excess inventory levels.

IncreaseIncrease If you select this message, production orders, purchase
orders, and other receipt transactions should be increased to
prevent shortages in inventory.

Derived actionsDerived actions If you select this message, action messages are created for
derived requirements, for example, actions for component
orders fulfilling the production.

NOTENOTE

An action message is a system-generated suggestion to change an existing planned or firmed order.

Action messages are generated by the master planning calculation in response to changed requirements. For

example, the ship date or quantity may have changed on a sales order for which you have already created a

purchase order to fulfill the demand. In this case, one or multiple action messages are generated by the master

planning calculation to update the purchase order. You decide whether to make the changes that are suggested.

You can set up how action messages are calculated for a coverage group that you attach to an item.

On the Coverage groupsCoverage groups  page, you can select the action messages that you want the system to generate, and

the coverage groups or items that the messages apply to. You can select the following action messages.
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Use a Gantt chart to visualize master planning progress

Turn on and use the Master plan progress visualization featureTurn on and use the Master plan progress visualization feature

Analyze a master planning jobAnalyze a master planning job

Navigation in the Gantt chartNavigation in the Gantt chart

From the View master planning progressView master planning progress  page, you can view details of historical master planning runs as a

Gantt chart. This functionality can help you understand the time that is spent on the various phases of master

planning. For a current active planning job, the View master planning progressView master planning progress  page can be used to track

progress and view the estimated remaining time.

To use this functionality, follow these steps.

1. In the Feature managementFeature management workspace, on the NewNew  tab, select Master planning progressMaster planning progress

visualizationvisualization in the list. If the feature doesn't appear on the NewNew  tab, look on the Not enabledNot enabled and AllAll

tabs.

2. Select Enable nowEnable now . Alternatively, select ScheduleSchedule, and then select the time when you want the feature to be

turned on.

The View master planning progressView master planning progress  page can display both historical planning jobs and active planning jobs.

To view historical planning jobs, there are two options.

1. Go to Master planning > Setup > Plans > Master plansMaster planning > Setup > Plans > Master plans , and then, on the Action Pane, select Histor yHistor y .

With the desired job selected, select Inquir iesInquir ies , and then select View progressView progress

2. Go to Master planning > Workspaces > Master planningMaster planning > Workspaces > Master planning, on the Master planning tile click Histor yHistor y .

With the desired job selected, select Inquir iesInquir ies , and then select View progressView progress

To view active planning jobs, there are two options.

1. Go to Master planning > Workspaces > Master planningMaster planning > Workspaces > Master planning, on the Action Pane, select UnfinishedUnfinished

planning processplanning process . With the desired job selected, select Inquir iesInquir ies , and then select View progressView progress .

2. Go to Master planning > Workspaces > Master planningMaster planning > Workspaces > Master planning, on the Master planning tile click ViewView

progressprogress . With the desired job selected, select Inquir iesInquir ies , and then select View progressView progress

Note you can view active jobs only when a planning job is processing.

In the Gantt chart, you can expand each of the following planning processes to view additional details about the

time that is spent:

Initializing

Deleting and inserting data

Coverage planning

Delays

Action messages

Finalization

Auto-firming

The Gantt chart is a useful tool if you want to view the impact of using action messages.
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View an additional master planning run to compare jobsView an additional master planning run to compare jobs

BOM-level displayBOM-level display

B O M  L EVEL  T H AT  ISB O M  L EVEL  T H AT  IS
SH O W NSH O W N EN D IT EMEN D IT EM SUB C O M P O N EN TSUB C O M P O N EN T RAW  M AT ERIA LRAW  M AT ERIA L

Coverage planning 0 1 2

Delays 0 –1 –2

Action message 0 1 2

Auto-firming 999 998 997

Visualize progressVisualize progress

Run master planning and track processing time

To expand the selected group and show the details, select the plus sign (++) in the tree view.

To collapse the selected group, select the minus sign (––) in the tree view.

You can use your keyboard for navigation. Use the Up arrowUp arrow  and Down arrowDown arrow  keys to move between rows.

Use the Right arrowRight arrow  and Left arrowLeft arrow  keys to expand and collapse groups.

To open or close all levels in the Gantt chart, select Expand allExpand all  or Collapse allCollapse all .

To view the related processing time, hover over a task. (Tasks are the lowest level in the Gantt chart.)

By selecting a master planning job on field Show additional master planning runShow additional master planning run, you can view an

additional master planning run in the Gantt chart and compare the two jobs.

Bill of materials (BOM) levels are shown differently for coverage planning, delays, actions, and firming.

Coverage planningCoverage planning – BOM levels are shown as expected. They are calculated from the top down.

Example:Example: BOM level 0, 1, 2

DelaysDelays  – BOM levels are shown as the coverage planning BOM levels multiplied by –1. (In other words,

they have a negative sign.)

Example:Example: BOM level –2, –1, 0

Action messageAction message – BOM levels are shown as expected. They are calculated from the top down.

Example:Example: BOM level 0, 1, 2

Auto-firmingAuto-firming – BOM levels are shown as 999 minus the coverage planning BOM level.

Example:Example: BOM level 999, 998, 997

The following table summarizes the behavior.

If you view a master planning job that is currently running, progress is shown through colors in the Gantt chart.

The following colors apply to the blue theme. For other color themes, the colors will differ.

Dark blueDark blue – Completed planning tasks.

OrangeOrange – The task that is currently in progress.

L ight blueLight blue – The estimate for remaining tasks.

The color is shown only on the lowest level in the Gantt chart. Select Expand allExpand all  to view all tasks in the master

planning job. The estimate of remaining tasks is based on historical master planning jobs.

1. On the default dashboard, select Master planningMaster planning.



NOTENOTE

2. In the PlanPlan field, enter or select a value.

3. Select RunRun.

4. Set the Track processing timeTrack processing time option to YesYes .

5. In the Number of threadsNumber of threads  field, enter a number.

6. On the Records to includeRecords to include FastTab, select FilterFilter .

7. In the grid, select the row where the FieldField field is set to Item numberItem number .

8. In the Criter iaCriter ia field, enter a value.

9. Select OKOK.
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Identify production orders that are not started

Create a schedule

View the result of scheduled production orders

NOTENOTE

This procedure shows how to schedule production orders that are not yet started for a site. The demo data

company USMF is used to complete this procedure.

1. Go to Production control > Production orders > All production orders.

2. Use the Quick Filter to find records. For example, filter on the Site field with a value of '1'.

3. Open the Status column filter.

4. Apply a filter on the "Status" field, with a value of "Scheduled", using the "is exactly" filter operator.

1 represents a site in USMF. If you are not using USMF, select a site from your own company.

1. In the list, mark or unmark all rows.

2. On the Action Pane, click Schedule.

3. Click Schedule jobs.

4. In the Scheduling direction field, select 'Backward from delivery date'.

5. Select No in the Finite capacity field.

6. Select No in the Finite material field.

7. Click OK.

This may take a while.

1. In the list, mark the selected row.

2. On the Action Pane, click Production order.

3. Click All jobs.

4. Click Materials.

You can mark any row.

On this page, you can see the list of jobs. On the Scheduling tab, you can see the Start date and End

date for a job.

On this page, you can see the estimated material consumption for the operations on the production

order and the current available inventory.
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Create a materials and capacity plan for an item

Identify the urgent planned orders for the item

Firm all the urgent orders for the item

NOTENOTE

The production planner calculates the material and capacity requirements for the production of a specific item.

After the sourcing suggestions are created, he finds the orders at the site for which he is planning and firms the

orders, starting from the urgent ones. The most urgent orders are the ones that need to be firmed on the

current date. Use the demo data company USMF to perform these tasks.

1. Click Master planning.

2. Click Run.

3. Expand the Records to include section.

4. Click Filter.

5. In the list, mark the selected row.

6. In the Criteria field, type a value.

7. Click OK.

8. Click OK.

9. Refresh the page.

You need to navigate to the default Dashboard.

Example: D0001

This may take a few minutes.

1. Open Item number column filter.

2. Apply a filter on the "Item number" field, with a value of "D0001", using the "begins with" filter operator.

3. Open Order date column filter.

4. Apply a filter on the "Order date" field, with a value of current date, using the "is exactly" filter operator.

1. In the list, mark or unmark all rows.

2. Click Firm.

3. Click OK.
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Definition of a calendar

Calendars that affect master planning
Calendar for a coverage groupCalendar for a coverage group

Calendar for a vendorCalendar for a vendor

This topic provides an overview of supply chain calendars and how they affect master planning. The different

calendars used in master planning engine are explained, including how they affect the shipping and receiving

dates in the planned orders. Finally, recommendations regarding the assignment, use and update of the

calendars are given.

You can define a calendar to use in your organization in the page in Organization administration > Setup >Organization administration > Setup >

Calendars > CalendarsCalendars > Calendars .

Each date entry in a calendar can be openopen or closedclosed or base calendarbase calendar . This is specified in the ControlControl  column

in the Working timesWorking times  page. For each date:

OpenOpen - Indicates that work is performed on the selected day. The calendar will be updated according to the

working time template.

ClosedClosed - Indicates work that is not performed during the day.

Base calendarBase calendar  - Indicates that the specific date will inherit the working times and open/closed from the

base calendar. Therefore, when the base calendar is updated, the selected calendar will inherit operation

times from it.

For any closed dates, the Closed for pickupClosed for pickup check box will automatically be assigned. For open dates, you can

manually select the Closed for pickupClosed for pickup option. This indicates that work is performed on the date, but shipping

is not performed.

A coverage group indicates a common set of parameters used for replenishment of the items that belong to the

given coverage group.

To add a calendar for a coverage group, go to Master Planning > Setup > Coverage > Coverage groupsMaster Planning > Setup > Coverage > Coverage groups .

Find the coverage group to which you want to assign the calendar to and then select it on the CalendarCalendar  field.

The coverage group can be assigned in different pages: - On the Released product detailsReleased product details  page of an item. To

see the coverage group for an item, go to Product information management > Products > ReleasedProduct information management > Products > Released

productsproducts  and select the item to go to the Released Products DetailsReleased Products Details  page. You can see the item coverage

group under the PlanPlan FastTab. - On the Item coverageItem coverage page. In the released products details page, click ItemItem

coveragecoverage to go to the item coverage page. In the overview tab you can see different parameters for

replenishment depending on the site, warehouse, and product dimensions. The coverage group for each item

will be inherited from the coverage group on the Released product detailsReleased product details  page. This can be overridden by

using Use specific settingsUse specific settings  or Overr ide group settingOverr ide group setting on the GeneralGeneral  tab. - On the Master planningMaster planning

parametersparameters  page. If am item does not have a coverage group set in the previous pages, master planning will

take the general coverage group set on master planning parameters. This is set up in Master planning >Master planning >

Setup > Master planning parametersSetup > Master planning parameters  in the General coverage groupGeneral coverage group field .

To indicate the working days of a vendor, you can assign a purchase calendar to the vendor on the PurchasePurchase

order defaultsorder defaults  page for a vendor.
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Define the lead time for a purchased itemDefine the lead time for a purchased item

NOTENOTE

Define lead times from the trade agreements pageDefine lead times from the trade agreements page

Calendar for a warehouseCalendar for a warehouse

NOTENOTE

Closed for pickup policyClosed for pickup policy

Transport calendarTransport calendar

To set a calendar for a vendor, you need to create the calendar in Organization Administration > CalendarsOrganization Administration > Calendars

> Calendars> Calendars . When the calendar is created, you have to assign it to the vendor. Go to Accounts Payable >Accounts Payable >

Vendors > All vendorsVendors > All vendors  and select the vendor that you want to assign the calendar to. Then, on the vendor's

page on the Purchase order defaultsPurchase order defaults  FastTab assign the new purchase calendar using the drop-down menu.

The calendar for a vendor indicates the days on which they accept the placement of the purchase order and the

dates when they can deliver the orders to your company. Consequently, the order dates for purchase orders for

the vendor with a purchase calendar will be dates defined as open in the calendar. The delivery dates for those

orders will also be in open days, and thus, will impact the lead time of the purchased item.

To specify the purchase lead time (and if only working days should be considered) for an item, you need to go to

the default order settings page for the product, found under Product information management > ProductsProduct information management > Products

> Released products> Released products  and select Default order settingsDefault order settings .

The Working daysWorking days under purchase lead time indicates the working days of the vendor. For example, a calendar for

delivery only on Tuesdays with a lead time of 10 days and working days check box selected indicates that it would take 10

weeks (10 Tuesdays) for the item to be delivered. Thus, in most cases it is not recommended to select working days for

purchase order lead times.

Master planning can be set up to include all trade agreements for vendors. Trade agreements are fixed prices or

discount agreements that are set up for one or more customers or vendors for the sale or purchase of individual

or multiple products. Go to Master planning > Setup > Master planning parametersMaster planning > Setup > Master planning parameters  and on the PlannedPlanned

ordersorders  tab and select Find trade agreementsFind trade agreements  to include the trade agreements when planning. Master

planning can select the vendor with the Minimum lead timeMinimum lead time or with the Lowest unit pr iceLowest unit pr ice.

You can assign a calendar to a warehouse to indicate the open dates for receiving and shipping. If no calendar

has been assigned to a warehouse, it is assumed that it is open all days.

Assigning a calendar to a transit warehouse does not have any impact. Transit warehouses are used for supporting

transfer orders. The applicable shipping or receipt dates for the orders are defined by the open days within the "From"

warehouse and the "To" warehouse, and the mode of delivery calendar.

To indicate that a warehouse is open for receiving but pickup is not possible, you can use the Closed forClosed for

pickup policypickup policy  within the warehouse calendar. This also applies to customer pickups.

To indicate the dates that are available for shipping transfer orders from a From warehouseFrom warehouse, you can assign a

Transpor t calendarTranspor t calendar . You can set up a transport calendar per mode of delivery, or per mode of delivery and

from warehouse. The transport calendar is set up in Sales and marketing > Setup > Distr ibution >Sales and marketing > Setup > Distr ibution >

Modes of deliver yModes of deliver y . Select a mode of delivery and click the Transpor t calendarTranspor t calendar  button.

A line can be created for each warehouse and mode of delivery, where the calendar is added in the Transpor tTranspor t

calendarcalendar  column. It will specify the transport calendar that will be applied when goods are shipped from the

warehouse using the given mode of delivery. To apply a transport calendar to all shipments using a given mode

of delivery, a line can be created without specifying the warehouse. It will affect all shipments using the given

mode of delivery, regardless of the warehouse.



Calendar for a customerCalendar for a customer

Shipping calendar for a legal entityShipping calendar for a legal entity

How calendars affect dates in planning
Order date of a planned purchase orderOrder date of a planned purchase order

Delivery date of a planned purchase orderDelivery date of a planned purchase order

Shipping date of a planned transfer orderShipping date of a planned transfer order

If no transport calendar is assigned, it is assumed that all days are open for transport.

To indicate the dates when a customer can accept deliveries, you can assign a receipt calendar to the customer. If

no calendar is assigned to a customer, it is assumed that the customer can receive orders on all days. This will

affect the receipt date on the sales order lines. If you select a date in the sales order lines that is not "open" in the

customer calendar, the system will indicate that the receipt date is not valid.

Note that it is only possible to include one calendar per customer. If you need to include a calendar for each

different address for a customer, you can create one customer per address and then assign its respective

calendar.

The requested receipt date on the sales order lines is affected by the customer calendar and by the delivery date

control method. You can read more about how the earliest delivery date is calculated in Order Promising..

To indicate the dates in which a legal entity can ship goods, you can set up a shipping calendar under

Organization administration > Organizations > Legal entitiesOrganization administration > Organizations > Legal entities . Select the legal entity and add the

calendar in the Foreign trade and logisticsForeign trade and logistics  tab in the Shipping calendarShipping calendar  field. The shipping calendar will

act as a source of defaults for all warehouse calendars in the legal entity.

The order date in a planned purchase order indicates the date when the order is placed. It will be an open date

both in the vendor calendar and in the coverage group calendar. Sometimes, vendors need a few days of margin

between when they receive the purchase order and when they are able to ship the goods. These dates are

indicated in the vendor's margin days. However, if the item purchased is assigned to a coverage group with

margin days, these margin days will override the vendor's margin days.

The receipt date of a purchase indicates the date when you will receive the goods. It will be an open date in the

calendar. The calendar that will be taken into account to indicate which days the purchase orders can be received

are the following, in order from highest to lowest priority:

1. Vendor's calendar

2. Coverage group calendar

3. Warehouse calendar for the receiving warehouse

Note that the coverage group calendar can be set in different pages and will take priority in the following order :

1. Item coverage group on the Item coverageItem coverage page

2. Item coverage group on the Released products detailsReleased products details  page

3. Default item coverage group in Master planning parametersMaster planning parameters

When creating a transfer order between two warehouses, the shipping date and the receipt date are included in

the transfer order header, along with the "From" warehouse and "To" warehouse. The difference between these

two dates is the expected transportation time (in days) between the warehouses.

The shipping date of a planned transfer order indicates the date that the goods are shipped from the "From"

warehouse. The calendars used for specifying the available shipping date are listed by priority:

1. Warehouse calendar of the "From" warehouse

2. Coverage group calendar (see fallback order for this calendar above) If there is a warehouse calendar set, the

https://docs.microsoft.com/en-us/dynamics365/unified-operations/supply-chain/sales-marketing/delivery-dates-available-promise-calculations
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shipping date will be an open date in the calendar. If there is not a warehouse calendar set, it will take the

coverage group calendar.

The receipt date for a transfer order indicates the date that the goods are received in the "To" warehouse.

The calendars used for specifying the receipt date are the ones listed by priority:

1. Coverage group calendar

2. Warehouse calendar of the "To" warehouse If there is a coverage calendar set, the receipt date will be an open

date in the calendar. If there is not a coverage group calendar set, it will take the warehouse calendar.

When finding the shipment and receiving dates for the planned transfer, the margins established by the user for

shipping and receiving will also be considered.

It is important to set the calendars to identify the working days of the company. The best implementation is to

set a calendar for each element with different working days. In other words, all external calendars (customer,

vendor) and all internal (warehouse, coverage group, and mode of delivery) related to the company.

It is recommended to use one calendar per warehouse to include the specific changes only affecting the

warehouse. For example, two or more warehouses could have the same working days but a different pickup

policy. In that case, a calendar for each of the warehouses with its respective pickup policy is the best

implementation for the system to include the best dates for planned purchase, transfer, and production orders. If

no warehouse calendars are set, the legal entity calendar can be used as a source of defaults for the warehouse

calendar.

Regarding the coverage group calendar, it is important to consider that that has an overriding behavior

regarding receiving dates in master planning. Thus, it is recommended to use it with caution. Particularly, it is

useful in the case when replenishment needs to be done specific days in the week.

While it is important that all relevant calendars are assigned in their respective place (vendor, customer,

warehouse, mode of delivery, or coverage group), updating them is as important so they reflect the changes.

The system will define the production, transfer, purchase, and sales order dates depending on the combination

of the assigned calendars. It is a best practice to clarify who holds the responsibility for assigning and updating

the calendars in its corresponding areas. In case of a breakdown or any other unusual change in the working

days, it is essential to update the calendars according to it. All tasks which depend on calendars, such as master

planning and production scheduling, must be rerun when calendars are updated.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Parameters related to master planning performance

Number of threadsNumber of threads

NOTENOTE

Number of tasks in helper task bundleNumber of tasks in helper task bundle

This topic explains the various options that can help you improve the performance of master planning or

troubleshoot issues. It includes information about parameters and settings, as well as recommended

configurations and actions. Also included is a summary of all the important parameters that you should

consider when you have long-running master planning jobs.

This topic is intended for system admins or IT users who have the capability to troubleshoot. It's also intended

for production or supply planners because it includes information about parameters that are related to business

planning requirements.

Various parameters influence the running time of master planning and should be considered.

The Number of threadsNumber of threads  parameter lets you adjust the master scheduling process to help improve

performance on the specific data set. This parameter specifies the total number of threads that will be used to

run master planning. It causes parallelization of the master planning run, which helps decrease the running time.

You can set the Number of threadsNumber of threads  parameter in the Master planning runMaster planning run dialog box. To open this dialog

box, go to Master planning > Master planning > Run > Master planningMaster planning > Master planning > Run > Master planning, or select RunRun in the MasterMaster

planningplanning workspace. To determine the best value for this parameter, you will have to rely on a trial-and-error

process. However, you can use the following formulas to calculate an initial value:

If your industr y is manufactur ing:If your industr y is manufactur ing: (Number of threads) = (Number of planned orders ÷ 1,000)

Other wise:Other wise: (Number of threads) = (Number of items ÷ 1,000)

The number of helpers used during master planning must be less than or equal to the maximum number of

threads that are allowed on the batch server. If the number of helpers exceeds the number of threads on the

batch server, the extra threads won't do any work.

Setting the Number of threadsNumber of threads parameter to 00  (zero) increases the master planning running time. Therefore, we

recommend that you always set a value that is more than 0.

By changing the Number of tasks in task bundleNumber of tasks in task bundle setting (that is, the bundle size), you might be able to

decrease the running time. This setting controls the number of items that are planned together by a single

helper.

You can set the Number of tasks in task bundleNumber of tasks in task bundle parameter in the PerformancePerformance section on the GeneralGeneral  tab

of the Master planning parametersMaster planning parameters  page (Master planning > Setup > Master planning parametersMaster planning > Setup > Master planning parameters ).

The best value for this parameter depends on your data. Therefore, we recommend that you start with a value of

11 , and then use a trial-and-error process to determine the best value for your setup.

In general, we recommend that you increase the number of tasks when the number of items is very large (in the

hundreds of thousands). Otherwise, you should decrease the number of tasks. For the following specific

industries, consider these recommendations:

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/master-planning-performance.md
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Use of cacheUse of cache
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Number of orders in firming bundleNumber of orders in firming bundle

In the retail and distribution industries where there are many independent items, use many helpers because

there is no dependency between items.

In the manufacturing industry where there are many bills of materials (BOMs) and shared subcomponents,

use fewer helpers because dependencies between items might cause waiting times.

If you have performance issues, we recommend that you reduce the Number of helpers in task bundleNumber of helpers in task bundle setting to 11 .

You can then start the trial-and-error process to find the best value for your setup. In general, performance issues occur

when one item takes longer to process than the remaining items. In this case, you will see that two subsequent tasks that

have a status of CoverageCoverage in the master planning run take significantly different amounts of time to run. In extreme

cases, this difference might be as much as 30 minutes. You can infer the amount of time that tasks take to run by looking

at the duration of each task.

The Use of cacheUse of cache parameter lets you adjust the master scheduling process to help it perform better on the

specific data set. For example, you can adjust it to achieve the following results:

If more caching is done, more data is collected in data memory. The expectation is that the data will be used

again later. If the data is in memory, you might save some database requests. However, if more caching is

done, memory requirements increase.

If less caching is done, the same data might have to be fetched from the database more often. Additionally,

Application Object Server (AOS) stores little data in memory throughout the process.

It's difficult to predict which option will be better because each case depends not only on the data but also on

the hardware. For example, because less caching causes additional load on the database server, it probably isn't

a good idea to use that option if your database server is already overloaded.

You can set the Use of cacheUse of cache parameter in the PerformancePerformance section on the GeneralGeneral  tab of the MasterMaster

planning parametersplanning parameters  page (Master planning > Setup > Master planning parametersMaster planning > Setup > Master planning parameters ). The

effectiveness of caching depends heavily on the customer data. For example, if cached data is never needed, you

just waste memory if you store data until the end of the scheduling process. In this case, if you configure less

caching, performance might increase because AOS requires less memory and server resources are freed up for

other tasks.

In general, we recommend that you set the Use of cacheUse of cache parameter to MaximumMaximum, because the parameter is intended

as a performance enhancing feature. We recommend that you set the parameter to MinimumMinimum if you run on premises

and have limited memory (approximately 2 gigabytes [GB]).

The Number or orders in firming bundleNumber or orders in firming bundle parameter specifies the total number of orders that will be

processed at a time by each thread/batch. It causes parallelization of the autofirming process.

You can set the Number or orders in firming bundleNumber or orders in firming bundle parameter in the PerformancePerformance section on the

GeneralGeneral  tab of the Master planning parametersMaster planning parameters  page (Master planning > Setup > Master planningMaster planning > Setup > Master planning

parametersparameters ). Parallelization of the autofirming process is based on the orders that must be processed together.

For example, if this parameter is set to 5050 , each thread or batch task will pick up 50 orders at a time and process

them together. We recommend that you use a trial-and-error process to find the best value. However, you can

use the following formula to calculate an initial value:

(Number of orders per bundle) = (Number of demand items ÷ Number of threads)



NOTENOTE

Time fencesTime fences

ActionsActions

FuturesFutures

One heavy routine at a time

Review the session log

If you set the Number of orders in firming bundleNumber of orders in firming bundle parameter to 00  (zero), no parallelization of the autofirming

process will occur. The whole process will run on a single batch task and have a cumulative running time. Therefore, the

running time of your master planning will increase. For this reason, we recommend that you set this parameter to a value

that is more than 00  (zero).

Time fences specify how far in the future the calculations and other requirements must be calculated by master

planning. The larger the time fence is, the longer it will take master planning to run. Therefore, set the time

fences according to your business requirements. For more information about time fences, see Set up master

planning.

Among the time fences, you can also find the Action messageAction message parameter. The calculation of action messages

causes a longer running time for master planning. If action messages aren't regularly analyzed and applied

(daily, weekly, and so on), consider turning off the calculation during the master planning run. To turn off the

calculation, on the Master plansMaster plans  page (Master planning > Setup > Plans > Master plansMaster planning > Setup > Plans > Master plans ), set the ActionAction

messagemessage time fence to 00  (zero). Also make sure that the Action messageAction message setting is turned off for all the

coverage groups.

The calculation of futures causes a longer running time for master planning. If you aren't planning BOMs, or if

delays don't have to be propagated from supply to demand during planning, consider turning off futures

calculations during master planning. To turn off the calculations, set the FuturesFutures  time fence to 00  (zero) for the

master plan that you're running. Also make sure that the FuturesFutures  setting is turned off for all the coverage

groups.

When you schedule master planning, don't schedule any other batch job at the same time. Be especially careful

that you don't schedule any other heavy routines, such as inventory close, at the same time.

The system can collect additional information about the tasks that run during master planning. To have the

system collect this information, turn on the Track processing timeTrack processing time setting in the Master planning runMaster planning run dialog

box. The information that is collected can help you find bottlenecks in the run. For example, when the NumberNumber

of tasks in helper task bundleof tasks in helper task bundle parameter is set to 11 , you can identify the item that has the longest running

time. You can also compare the running times for the various threads that have a status of CoverageCoverage and

compare the duration for each task.

To review the master planning runs of your system, follow one of these steps.

In the Master planningMaster planning workspace, select a master plan in the drop-down field, and then on the MasterMaster

planningplanning tile, select Histor yHistor y . Select a job, select Inquir iesInquir ies  on the FastTab, and then select Process taskProcess task

durationduration.

On the Master plansMaster plans  page, select a plan in the left pane, and then select Histor yHistor y  on the FastTab. Select a job,

select Inquir iesInquir ies  on the FastTab, and then select Process task durationProcess task duration.

When you review the session log, consider the following:

UpdateUpdate should not take a long time (in general, it should take up to 30 minutes), however, it's single-

threaded.



Filtering of items

Automatically filter by items with direct demand

Pre-processingPre-processing

NOTENOTE

Post-processingPost-processing

Performance checklist summary

Copy planCopy plan should not take a long time (it should take about one minute).

Auto firmingAuto firming usually takes about 30 minutes. However, it can take up to multiple hours, depending on the

number of orders and the complexity of the items.

Auto firmingAuto firming should take less time than CoverageCoverage.

CoverageCoverage should take the longest time relative to the rest.

ActionAction and Future messageFuture message can take a long time, depending on the data and the number of BOMs.

Filters that are applied in the Master planning runMaster planning run dialog box affect the duration of the master planning run.

Go to Master planning > Master planning > Run > Master planningMaster planning > Master planning > Run > Master planning, or select RunRun in the MasterMaster

planningplanning workspace. To exclude items from the run, we recommend that you filter by the lifecycle state of the

item (not by item numbers). When you filter by lifecycle state, the update process will take less time than when

you filter by item numbers.

To improve the master planning run time, you can choose to only include items with direct demand. This filter

can only be used for a complete master planning run with no other filters applied in the Records to includeRecords to include

field. A master planning run with filters will ignore the Automatically filter  by items with direct demandAutomatically filter  by items with direct demand

setting.

The Automatically filter  by items with direct demandAutomatically filter  by items with direct demand field is found on the Master planningMaster planning

parametersparameters  page and can be used with both pre-processing and post-processing settings.

The Pre-processing: Automatically filter  by items with direct demandPre-processing: Automatically filter  by items with direct demand parameter ensures that the pre-

processing phase of master planning only includes items that fulfill at least one of the following conditions:

The item has an expected receipt or issue, such as a purchase order, sales order, quote, transfer order, or

production order.

The item has item coverage with safety stock (minimum on-hand inventory).

Forecast demand after today exists for the item.

Forecast supply after today exists for the item.

The item includes any continuity lines from the call center module yet to be created.

An item that has physically available on-hand inventory will not show a requirement transaction because there is no

demand for the item.

The Post-processing: Automatically filter  by items with direct demandPost-processing: Automatically filter  by items with direct demand option is only relevant if you set

BOM version requirementBOM version requirement in your coverage groups. Otherwise, you do not need to enable the parameter.

Before the coverage step starts, there is a pre-coverage step during which items with the coverage setting BOMBOM

version requirementversion requirement enabled will be reprocessed. This is done to ensure that items from the required BOM

version are planned. Items that are considered to have demand during pre-processing no longer have any

demand and therefore should be excluded from the planning run.

Number of threadsNumber of threads  – Set to a value that is more than 00  (zero).



NOTENOTE

Number of tasks in helper task bundleNumber of tasks in helper task bundle – Set to a value that is more than 00  (zero). (Use the formulas that

are given earlier in this topic.)

Use of cacheUse of cache – Set to MaximumMaximum unless your system is low on memory.

Number of orders in firming bundleNumber of orders in firming bundle – Set to a value that is more than 00  (zero). (Use the formula that is

given earlier in this topic.)

Time fencesTime fences  – Adjust to your business needs.

Actions and futuresActions and futures  – Disable actions and future if you don't use them.

One heavy routine at a timeOne heavy routine at a time – Don't run master planning together with any other heavy routine.

Review the session log.Review the session log.

Filter ing of itemsFilter ing of items – Use the lifecycle state to exclude items from the master planning run. (Don't use the

item numbers.)

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Overview of basic scheduling flow

Load data into the engine

The resource scheduling engine is used when scheduling routes for planned and released production orders.

The engine was originally released as part of Dynamics AX 2012 and has gone through several improvements

since its release.

The job shop scheduling problem is an extremely complex combinatorial problem where solution time grows

exponentially with the number of decision variables. Oftentimes, customers set up production routes and related

data in a way that results in a scheduling problem that can't be solved in reasonable time even on the most

modern hardware. This topic will help you understand the scheduling engine and how a specific setup can have

influence on the performance.

When it comes to improving the performance of the scheduling, general guidelines recommend reducing the

complexity of the problem the engine needs to solve. Some of the main factors that can affect performance

include:

Routes with many operations

Routes with parallel operations

Operations with quantity of resources higher than one

Operations with many applicable resources

Use of hard links

Use of finite capacity

The number of different calendars used

The number of working time slots per day in the calendar

Total duration of the route

Running multiple scheduling engines in parallel

To understand how a given setup can affect performance, it is important to understand something about how

the process flows, both inside the engine and in the X++ code that surrounds it.

The basic process of scheduling an order consists of three main steps:

Loading dataLoading data – Here, the X++ data models are transformed into the engine's internal data model in the

form of jobs and constraints.

SchedulingScheduling – This is the main source for scheduling that processes the given model and constraints, and

generates a result. During this process, the engine will request working time information and existing

capacity reservations from X++ as needed.

Save dataSave data – The engine result in the form of job capacity reservation slots is processed by X++ code to save

capacity reservations and update the start and end times of the jobs/operation/order.

The scheduling engine has a more abstract data model than the Supply Chain Management database because it

has been built as a generic engine that can handle different sources of data. The concepts of route, secondary

operations, and run time need to be "translated" into the generic job and constraint model that the engine

exposes. The logic for building the model has a significant amount of business logic to it and is different

depending on the source data. The responsible X++ class is WrkCtrScheduler  and it has derived classes for

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/scheduling-engine-performance.md
https://en.wikipedia.org/wiki/Job_shop_scheduling
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planned production orders, released production orders, and project forecasts.

As an example, consider a route shown in the following table and image, which seems relatively simple.

When sending this to the engine, it is split out into eight jobs, as shown in the following illustration (select the

image to enlarge it).

The standard link between two jobs is FinishStart , meaning that the end time of one job must be before the

start time of another job. Because the setup must be performed by the same resource that will later do the

process, there are OnSameResource  constraints between them. Between the jobs for primary and secondary

operation for 10, there are StartStart  and FinishFinish  links, which means that the jobs must both start and

end at the same time, and there are NotOnSameResource  constraints, which will prevent the same resource for

primary and secondary.

For operation 20, where the quantity of resources has been set to 3, the process job has been split into three

distinct jobs where all the jobs must run at the exact same time. In this case, the route group has been set up to

not reserve capacity for queue after times, which is why there is only a single job for the queue after.

The scheduling engine only understands the concepts of jobs and has no notion of operations. This means that

when doing operation scheduling, the operations are also split into jobs, although these will not be persisted in

the database.

For each job, we will also define what the job capacity requirement is (the number of seconds required).

Depending on how the resource requirements have been defined, we may also, for each job, send a list of all the

potential applicable resources that the job could run on and what the capacity requirement is for that specific

resource. Even though the list of applicable resources is sent when building the model, the engine will still need

file:///T:/eiye/ac1a/dynamics365/supply-chain/master-planning/media/scheduling-engine-jobs-large.png


Scheduling engine internals
Scheduling engine interfaceScheduling engine interface

General engineGeneral engine
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run Schedules all loaded jobs and returns the error code.

getJobSchedulingSequenceResult Gets the scheduling result and the first error job for the
sequence identified by a specific job.

validateJobCapacityReservations Validates the capacity reservations for all the jobs stored by
the engine.

setReservationsTimeStamp Sends a timestamp to the engine set on all new capacity
reservations for the scheduled jobs in the cache of the
engine.

addPropertyToGroupAggregation Adds a property prefix to the set of properties used when
capacity is aggregated.

addResource Adds a resource to the scheduling engine resource pool.

addResourceGroup Adds a resource group to the scheduling engine resource
group pool.

addResourceGroupMembership Adds a resource as a member to a resource group.

addOptimizationGoal Adds a scheduling optimization goal (duration or priority).

Individual jobsIndividual jobs

M ET H O DM ET H O D P URP O SEP URP O SE

addJobInfo Adds a job information record that informs the engine about
a job that should be scheduled.

addConstraintJobEndsAt Adds a constraint that a job should end at a specified date
and time.

addConstraintJobStartsAt Adds a constraint that a job should start at a specified date
and time.

addConstraintMaxJobDays Defines the constraint that a job can span over a specified
maximal number of days.

addConstraintResourceRequirement Adds the constraint that the job must be scheduled on a
specific resource.

to ensure that the resource assignment is actually valid for the entire job duration.

To get an idea of how the engine works internally, it is best to look at the functionality it exposes externally. In

X++, the main interface is WrkCtrSchedulerEngineInterface . It has the methods described in the following

subsections.



addJobBindPriority Adds a job bind priority for a ( job, constraint level) pair. A
higher priority value means the job variables will be bound
earlier. The job will be processed before jobs with lower
priority value in the same sequence.

addJobCapacity Adds capacity load information for a job (like the required
job runtime) independent on which resource the job runs on.

addJobResourceCapacity Adds a resource to the set of resources that may be used to
perform a job, and states the capacity required when
running on that resource.

addJobGoal Adds job goal information for a specific constraint level
(earliest end time or latest start time).

addJobResourcePriority Adds the priority to use when a job is scheduled on a
resource.

addJobResourceRuntime Specifies a job time that is dependent of the resource the job
will be scheduled on.

addJobRuntime Specifies a job time that is independent of the resource on
which the job will be scheduled.

scheduleJobOnResourceGroup Marks a job for scheduling on the resource group level.

setJobResourcePreemptionAllowed Sets whether preemption is allowed for a job on a resource
(if engine is allowed to schedule the job in noncontiguous
capacity slots).

setRequiredNumberOfResources Sets the number of resources required to schedule a job
(only for operations scheduling).

M ET H O DM ET H O D P URP O SEP URP O SE

Constraints between jobsConstraints between jobs

M ET H O DM ET H O D P URP O SEP URP O SE

addJobLink Adds a link (such as finish>start) between two jobs.

addConstraintEndsDelayed Defines the constraint that a job cannot end before another
jobs end plus some delay time.

addConstraintJobListWorkingTimeIntersect Adds a constraint that the capacity slots reserved for the
jobs must be on the intersecting working times for the two
resources used by the jobs.

addConstraintJobOverlap Add a constraint that defines how jobs are sequenced when
a given quantity of an item can be moved between two
resources while the first resource is still not finished
processing, so that the second resource can start processing.

addConstraintNotOnSameResource Adds a constraint that two jobs should not be scheduled on
the same resource.



addConstraintOnSameResource Adds a constraint that two jobs must be using the same
resource.

addJobSameReservations Adds a constraint that a job must end up having capacity
reservations for the same time slots as the primary job.

setPrimaryParallelJob Adds information about what job is the primary job in a set
of parallel jobs.

M ET H O DM ET H O D P URP O SEP URP O SE

SolverSolver

VariableVariable

ConstraintConstraint

Constraint levelsConstraint levels

AlgorithmAlgorithm

The engine itself is essentially a specialized constraint solver with custom heuristics added. The solver is based

on two main elements: variables and constraints.

A variable represents a domain of possible values. Scheduling engine has two types of variables:

DateTime var iableDateTime var iable - Has a domain of all dates and times, and the domain can be restricted by moving the

lower and upper bound for the time of the variable closer to each other.

Resource var iableResource var iable - Has a domain of applicable resources, and the domain can be restricted by eliminating

resources from the list.

A constraint acts on variables by restricting their domains, but it also depends on variables so it gets activated

when variables change. The process of "constraint propagation" is when a constraint performs its main function

and reports back to the main logic if successful.

A variable is considered bound when it can't be restricted further, which for DateTime variable means that upper

and lower bound is the same, and for the Resource variable that it has only a single applicable resource. When

all variables are bound, a solution is found.

When scheduling is executed as part of the material requirements planning (MRP) coverage phase, the orders

will be scheduled backward from requirement date. However, if it is not possible to find a schedule that starts

today or later and ends before the requirement date, then the scheduling direction will change to forward from

today.

This main business rule is handled by organizing the constraints in levels. If no solution is found when using the

constraints on the highest level, then the constraints on that level are all dropped, and the lower level is tried. In

praxis, this means that for backward scheduling the model will contain a level 1 with job goals of latest start

time given a maximum end time constraint (the requirement date), and a level 0 with job goals of earliest end

time and given a minimum start time constraint of today.

The main steps of the engine algorithm are:

1. Find sequences ( job chains) which can be solved separately.

2. Try to find an initial solution for the sequence for the highest constraint level.

a. Sort the jobs in the sequence based on job goal and priorities, such that a start job can be found.

b. Loop the jobs in the following sequence:

a. Find all constraints that need to be propagated and run propagation.

b. If all variables for the job have been bound, then a solution for that job has been found.

c. If one of the variables could not be bound without violating the constraints, then roll back the

variable binding, try a different value in the domain (for resource variable), and rerun the



Determining working timesDetermining working times

Finite capacityFinite capacity

Examining the resource combinationsExamining the resource combinations

3. If no solution was found, then all constraints on the current constraint level is removed, the constraint level

lowered (if any lower levels are available) and solution search retried with the new set of constraint.

4. If a feasible solution was found, then the optimization phase is started, which will try to find a better solution

until the optimization timeout is reached or all resource combinations have been exhausted.

constraint propagation.

The constraint solver is not aware of the specifics of the scheduling algorithm. It is in the definition and

combination of the various constraints that the "magic" happens.

A large part of the (internal) constraints in the engine controls the working time and capacity of a resource.

Essentially, the task is to traverse the working time slots for a resource from a given point in a given direction,

and find a long enough interval in which the jobs required capacity (time) can fit.

To do this, the engine needs to know the working times of a resource. Opposite to the main model data, the

working times are lazy loaded, meaning that they are loaded into the engine as needed. The reason for this

approach is that there are often working times in Supply Chain Management for a calendar for a very long

period and typically many calendars exist so the data would be quite large to pre-load.

Calendar information is requested by the engine in chunks, by invoking the X++ class method 

WrkCtrSchedulingInteropDataProvider.getWorkingTimes . The request is for a specific calendar ID in a specific time

interval. Depending on the state of the server cache in Supply Chain Management, each of these requests could

end up in several database calls, which takes a long time (relative to the pure computational time). Also, if the

calendar contains very elaborate working time definitions with many working time intervals per day, this adds

to the time the loading takes.

When the working time data is loaded in the scheduling engine, this is retained in its internal cache for the

specific calendar, meaning that if any other jobs or resources are using the same calendar then the next lookups

can be performed quickly from memory. One common cause of bad performance is if a separate calendar ID is

used for each resource, because data will then need to be requested for each calendar, even though the content

of the calendars might be the same.

When using finite capacity, the working time slots from the calendar are split and reduced based on the existing

capacity reservations. These reservations are also fetched through the same 

WrkCtrSchedulingInteropDataProvider  class as the calendars, but instead use the method 

getCapacityReservations . When scheduling during master planning, the reservations for the specific master

plan are considered and if enabled on the Master planning parametersMaster planning parameters  page, the reservations from firmed

production orders are also included. Similarly, when scheduling a production order, it is also an option to include

reservations from existing planned orders, although this is not as common as the other way around.

Using finite capacity will cause scheduling to take longer due to several reasons:

Fetching the capacity information from database is a slow operation and the server-side caching of capacity

information is typically not as good as for working times because they are not shared among resources like

calendars typically are.

The number of working time slots to traverse increases due to the splits, and slots for a longer time period

must typically be investigated before a solution can be found.

After the scheduling is complete, a check for conflicting reservations must be performed (see the "Running

scheduling engines in parallel" section for details).

If the job sequence only contains the standard FinishStart  links, meaning it forms a simple chain without any

branches, an optimal result (seen from the single order, not across orders) can be achieved by finding the best

solution for the first job and then moving on to find the best solution for the next job. The best solution for a job
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means finding the resource that can get the from and to date of the job closest to the job goal (in forward

scheduling this means getting the end date of the job as early as possible) while still respecting the constraints.

When there are parallel jobs, finding a solution may involve examining different combinations of resources. The

number of possible resource combinations is the product of the number of applicable resources for the

connected parallel jobs. Especially when scheduling an order backwards from a requirement date, it can take

quite a while for the logic to realize that there is no solution to the problem that will make the parallel jobs fit

before today's date, as it will need to check all the combinations because there could be some resources that had

a higher efficiency or a different calendar that might give a result. This means that if no timeout limit has been

set it will run for a long time before changing the direction to forward.

This combinatorial logic also means that adding more applicable resources may make the engine run slower. If

performance problems occur when having parallel operations and scheduling with infinite capacity, it can partly

be fixed by having the route designer take a decision on which resource should be used and then assign the

resource directly on the operation (because the engine in most cases will always end up picking the same

resource, so the end result will be the same).

Setting the link type between two jobs to hard, ensures that there is no time gap between the finish of one job

and the start of the next one. This can be very useful in scenarios like when metal is heated in one job and then

processed in the next job, where it is not desirable to have the metal cool down in between.

With standard soft links and forward scheduling, if the route forms a simple chain without any branches, a result

can be achieved by finding a solution for the first job that satisfies its own constraints and then moving on

through the chain propagating the end time from the previous job to the next job. If the current job can't find

any capacity, the start time for it will be moved out further, without any consequence for the previous jobs

potentially creating gaps between the jobs. However with hard links (especially in connection with finite

capacity) for the same scenario, the fact that one job later in the chain cannot find capacity, will mean that all

previous scheduled jobs will have to be "dragged" along one by one and thereby rescheduled a number of

times. Especially in scenarios with high load for multiple resources, the hard links can cause a chain reaction

where the jobs will affect each other and a number of iterations will have to be performed before the result

stabilizes into a feasible schedule.

When performing scheduling as part of a master planning run where helpers are used, each of the master

planning helper threads can also pick up production order scheduling tasks. This means that multiple scheduling

engines can be running at the same time. While multithreading in general is a highly significant performance

benefit, there are also some functional downsides when it comes to scheduling.

In MRP, all production orders for a given bill of materials (BOM) level are scheduled in requirement date

sequence, meaning that those orders with the earliest requirement date should be scheduled first and thereby

have the highest chance of getting the available resource capacity. However, with multiple engines picking from

the list of unscheduled orders the sequence is no longer ensured, as one might complete faster than the other.

Also, when scheduling using finite capacity and when multiple engine instances are trying to schedule orders

that are potentially using the same resources at the same time interval, a race condition can occur. The number

of such race conditions is recorded in the Scheduling conflictsScheduling conflicts  field on the master plans history page. The

conflict resolution logic is as follows:

Schedule an order (lock-free) and get capacity reservations.

Take the lock.

Check if newer capacity reservations exist for the scheduled resources in the timespan.

If no, write the capacity and release the lock.
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If yes, release the lock and reschedule the order from the beginning.

So, when scheduling with multiple engine instances, the result is not fully deterministic because it will depend

on the exact timing of each of the threads.

Even though operation scheduling is also known as rough-cut capacity planning, seen from an engine

standpoint, it can be a harder problem to solve if finite capacity is used, as more data is needed to determine

feasibility.

The capacity of a resource group depends on which and how many resources are members of the resource

group. A resource group in itself does not have any capacity—only when resources are a member of the group

will it have capacity. Because the resource group membership can vary over time, capacity must be evaluated

per day.

In operations scheduling, the resource group's calendar is used to determine the start and end times for each

operation. This means that the resource group's calendar places a limit on how much time can be operations

scheduled for one operation on one day in one resource group. Opposite the calendar for the specific resources,

the efficiency data of the calendar is ignored for the resource group as it simply denotes opening hours and not

actual capacity.

For example, if the working time for a resource group on one specific date is from 8:00 to 16:00, one operation

can't put more load on the resource group than what can be fit into 8 hours, no matter how much capacity that

the resource group has available in total on that day. The available capacity can however limit the load further.

The load from job scheduling on all the resources included in the resource group on a given day is considered

when the available capacity for the resource group on the same day is calculated. For each date, the calculation

is:

Available resource group capacity = Capacity for resources in the group based on their calendar – Job scheduled

load on the resources in the group – Operations scheduled load on the resources in the group – Operations

scheduled load on the resource group

On the Resource requirementsResource requirements  tab on the route operation, the resource requirements can be specified using

either a specific resource (in which case the operation will be scheduled using that resource), for a resource

group, for a resource type, or for one or more capabilities, skill, course, or certificate. While using all of these

options gives a great flexibility on the route design, it also complicates the scheduling for the engine as the

capacity must be accounted for per "property" (the abstract name used in the engine for capability, skills, and so

on).

The resource group's capacity for a capability is the sum of the capacity for all resources in the resource group

that has the capability in question. If a resource in the group has a capability, it will be considered no matter

what level of the capacity is required.

In operations scheduling, the available capacity for a certain capability for a resource group will be reduced

when it is loaded with an operation that requires the capability in question. If the operation requires more than

one capability, the capacity will be reduced for all required capabilities.

For each date, the required calculation is:

Available capacity for a capability = Capacity for the capability – Job scheduled load on the resources with the

specific capability, included in the resource group – Operations scheduled load on the resources with the specific

capability, included in the resource group – Operations scheduled load on the resource group itself that require

the specific capability

This means that if there is load on a specific resource, the load is considered in the calculation of the resource
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group's available capacity per capability, because the load on a specific resource reduces its contribution to the

resource group's capacity for a capability no matter if the load on the specific resource is for that specific

capability. If there is load on the resource group level, it is considered in the calculation of the resource group's

available capacity per capability only if the load is from an operation that requires the specific capability.

The above logic is complicated, as this is the same for each type of "property" so using operations scheduling

with finite capacity requires a significant amount of data to be loaded.

To get specific details of the input and output of the scheduling process, enable logging by going to

Organization administration > Setup > Scheduling > Scheduling tracing cockpitOrganization administration > Setup > Scheduling > Scheduling tracing cockpit.

On this page, first select Enable loggingEnable logging on the Action Pane. Then run the scheduling for the production order.

When complete, return to the Scheduling tracing cockpitScheduling tracing cockpit page and select Disable loggingDisable logging on the Action

Pane. Refresh the page and a new line will appear in the grid. Select the new line and select DownloadDownload on the

Action Pane. This will give you a .zip compressed folder containing the following files:

Log.txtLog.txt - This is the log file that describes the steps that the engine goes through. It is very elaborate and can

be a bit overwhelming, but when used as part of experimenting with the route setup to resolve performance

problems the first thing to look for is the difference in time between the first and the last line, as this will give

you the exact time the scheduler has spent.

XmlModel.xmlXmlModel.xml  - This contains the model that is built in X++ and that the engine operates on. The JobId

used in the file correlates to the RecId  from the source table containing the jobs ( ReqRouteJob  or 

ProdRouteJob ). The typical thing to look for in this file is that the dates given in ConstraintJobStartsAt  and 

ConstraintJobEndsAt  are as expected, that the JobGoal  property is set correctly, and that the jobs are related

to each other through the JobLink  constraints.

XmlSlots.xmlXmlSlots.xml  - This contains all the working times and capacity reservations that the engine has requested.

The calendar working times and reservations will only be requested by the engine for the time periods where

it tries to place the jobs (and an extra buffer), so if the file contains times very far in the future, it might be an

indication of a problem with the setup. The ResourceProperty  nodes will show for each resource which

resource group and capabilities it is associated with for which periods.

Result.xmlResult.xml  - This contains the result of the scheduling run.

Note that the tracing functionality can add significant performance overhead, so only use it for investigating

scheduling of specific orders in a controlled manner. If it is turned on during a master planning run it will quickly

reach its size limit and stop.

As can be understood from all of the previous sections, there are some pitfalls when it comes to the setup and

usage of the scheduling engine, which can lead to performance problems. The following check list can be used

for troubleshooting such issues. It is important to look at all the points as it is most often a combination of

multiple factors that leads to problems.

Even though routes are used for the production control purposes such as costing and reporting, it might not be

necessary to consider them during MRP. In some cases, having a standard production lead time specified for the

item will be sufficient for planning. To turn off route scheduling, set the capacity time fence to zero. If scheduling

should be done, then the capacity time fence must be carefully set because it might not be necessary to consider

routes for the full extent of the MRP's coverage time fence.

Note that if the order is not scheduled during MRP, then it will instead need to be scheduled when the planned

order is firmed. This means that the firming process will take longer, so depending on how many of the
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suggested planned orders get firmed the performance gain during MRP might be lost at firming.

When designing the route, it is tempting to try to model the real world exactly with all the steps the production

goes through. While this can be useful in some cases, it is not good for the performance as the model the engine

needs to work on gets larger (both in terms of jobs and constraints) and more SQL statements will be executed

for insertion and update of the jobs and capacity reservations. Also, there is the downstream effect of having to

eventually report progress on the jobs, which can be mitigated with automatic postings. If the data is not used

for anything, it creates unnecessary load.

We recommend that you only create operations that are strictly needed for scheduling (which will typically be

the bottleneck resources) and/or costing purposes. Alternatively you should group many smaller distinct

operations into one larger operation that represents a greater part of the process.

The number of applicable resources for an operation is determined by the resource requirements set on the

operation relation. The requirement can either be for a specific (individual) resource or it can be based on the

resource's membership of a resource group or capability.

If scheduling is not done using finite capacity and all the applicable resources have the same calendar and

efficiency, then the scheduling engine will always end up picking the same resource for an operation, but only

after trying all the applicable resources to check if there is one that is "better" than the others. In this case, the

load of the scheduling can be greatly reduced simply by always assigning a specific resource to the operation at

the route design time.

While parallel operations (primary/secondary) are a powerful tool to model scenarios like when a machine and

an operator are both needed to perform a specific task, it is also the source of many performance issues. If a

requirement for a specific individual resource is assigned to both the primary and secondary operation, it is

typically not a problem. But if there are many possible resources for each of the operations, then it adds

significant computational complexity to the scheduling.

An alternative to using parallel operations is either to model the pairs as "virtual" resources (which will then

represent the team that always goes together for the operation) or to simply not model one of the operations if

it doesn't represent a bottleneck.

If setting the quantity of resources needed for an operation higher than one, then it results effectively the same

as using primary/secondary operations because multiple parallel jobs are sent to the engine. However, for this

case there is not an option of using specific resource assignments, because a quantity higher than one requires

that more than one resource is applicable for the operation.

Use of finite capacity requires the engine to load the capacity information from a database and can have a

computational overhead because it will be harder to find a solution especially in environments where the

resources are booked close to their maximum capacity. As a result, it is important to carefully evaluate if a

resource really needs to use finite capacity or they can be overbooked. Because there might be a difference

among finite capacity resources in how important they are not to overbook, we recommend using the

bottleneck option on a resource in combination with a separate value on the plan in "Capacity time fence for

bottleneck resources". Using the bottleneck concept can enable that the general finite capacity time fence can be

lowered.

The standard link type of the route is soft, which means that a time gap is allowed between the finishing time of

one operation and the start of the next. Allowing this can have the unfortunate effect that, if materials or
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capacity are not available for one of the operations for a very long time, the production could be idle for quite a

while, meaning a possible increase of work in progress. This will not happen with hard links because the finish

and start must align perfectly. But setting hard links makes the scheduling problem more difficult because

working time and capacity intersections must be calculated for the two resources of the operations. If there are

also parallel operations involved, this adds significant computational time. If the resources of the two operations

have different calendars that don't overlap at all, the problem is unsolvable.

We recommend using hard links only when strictly necessary, and carefully consider if it is necessary for each

operation of the route.

To reduce the work in progress without applying hard links, a trick is to schedule the order twice with changing

to the opposite direction for the second pass. If the first schedule was done backwards from delivery date, then

the second should be done forward from the scheduled start date. This will result in the jobs being compressed

as much as possible so that the work in progress is minimized.

One of the main sources of data for the scheduling engine is calendar information, which can be expensive to

load from the database. Because calendars are generated based on templates, it would be tempting to generate

a calendar for each resource and then adjust the information in this calendar when the resource has downtime

and other issues. However, doing this will severely limit the engines ability to cache the calendar data as it would

need to request new data for each resource and can be a large source of performance problems. Instead, we

recommend that you reuse the calendars as much as possible between the resources, and then control

downtime changes by assigning a different calendar ID for a period.

Because the engine works by examining time slots one-by-one for capacity, it is beneficial to minimize the

number of time slots per calendar day. This could be done, for example, by considering whether it's important

for the resulting schedule to reflect that workers have a 5-minute break every hour.

Scheduling engine performance can be optimized using parameters found on the Scheduling parametersScheduling parameters

page. The Scheduling timeout enabledScheduling timeout enabled and Scheduling optimization timeout enabledScheduling optimization timeout enabled settings should

always be set to YesYes . If set to NoNo, the scheduling can potentially run infinitely if an unfeasible route with many

options has been created.

The value for Maximum scheduling time per sequenceMaximum scheduling time per sequence controls how many seconds can, at most, be spent

trying to find a solution for a single sequence (in most cases a sequence corresponds to a single order). The

value to use here highly depends on the complexity of the route and settings like finite capacity, ut a maximum

of about 30 seconds is a good starting point.

The value for Optimization attempts timeoutOptimization attempts timeout controls how many seconds can at most be used to find a

better solution than the one originally found. This will only influence routes that are using parallel operations as

these make it necessary to test different combinations.

The values set for the timeouts will be applied both for scheduling of released production orders and of planned orders as

part of MRP. As a result, setting very high values could significantly add to the run time of MRP when running for a plan

with many planned production orders.
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Master planning takes the settings of the site and warehouse inventory dimensions into account.

The site dimension is mandatory, and you can set the warehouse dimension to be mandatory.

When a dimension is mandatory, a dimension value must be entered on all inventory transactions. Therefore,

during master planning, the site and the warehouse for the initial demand are known. The site dimension is also

consistent so that during the explosion of lower-level demand, the site value does not change.

When the warehouse is not set to mandatory, it may not be known from the initial demand. The planning engine

must determine which warehouse to use based on the settings that are defined for the item, individual

warehouses, and the details of the order line.

The following topics describe how the planning engine works, when different settings are defined, to determine

the warehouse to use.

Master planning for site and warehouse coverage, warehouse mandatory

Master planning for site coverage, mandatory warehouse

Master planning for site and warehouse coverage, warehouse not mandatory

Master planning for site coverage, warehouse not mandatory
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This topic describes how an item that has the site as coverage dimension is planned. Warehouse is a mandatory

dimension.

This master planning scenario involves the following conditions:

The site dimension is set to mandatory and must be entered on the demand transaction. This setting can't be

modified.

The warehouse dimension is set to mandatory and must be entered on the demand transaction.

The site dimension is set for coverage planning. Other dimensions may be set for coverage planning also.

However, they are not affected by the multisite functionality.

The warehouse dimension is not set for coverage planning. Therefore, supply and demand are aggregated by

site and, perhaps, other coverage-planned dimensions also.

The following graphic illustrates how master planning proceeds. The parameters that are referred to in the

graphic, and their locations, are as follows:

Item coverage is defined for the item. Click Product information management > Products> ReleasedProduct information management > Products> Released

productsproducts . Select the item, and then click Plan > Item coveragePlan > Item coverage.

Refill relations are defined for the warehouse. Click Inventor y management > Setup > Inventor yInventor y management > Setup > Inventor y

breakdown > Warehousesbreakdown > Warehouses . On the Master planningMaster planning tab, see the Main warehouseMain warehouse field group.

The default order type is set to Production, Purchase order, or Kanban. Click Product informationProduct information

management > Products> Released productsmanagement > Products> Released products . Select the item, and then click Plan > Default orderPlan > Default order

settingssettings . In the Default order settingsDefault order settings  form, see the Default order typeDefault order type.
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This topic describes how an item that has the site dimension set for coverage is planned.

This master planning scenario involves the following conditions:

The site dimension is set to mandatory and must be entered on the demand transaction.

The warehouse dimension is not set to mandatory. The warehouse may be known, but it is not used in the

master planning calculation.

The site dimension is set for coverage planning.

The warehouse dimension is not set for coverage planning. Therefore, supply and demand are aggregated by

site and, perhaps, other coverage-planned dimensions also.

The following graphic illustrates how master planning proceeds. The parameters that are referred to in the

graphic, and their locations, are as follows:

Item coverage is defined for the item. Click Product information management > Products> ReleasedProduct information management > Products> Released

productsproducts . Select the item, and then click Plan > Item coveragePlan > Item coverage.

Refill relations are defined for the warehouse. Click Inventor y management > Setup > Inventor yInventor y management > Setup > Inventor y

breakdown > Warehousesbreakdown > Warehouses . On the Master planningMaster planning tab, see the Main warehouseMain warehouse field group.

The default order type is set to Production, Purchase order or Kanban. Click Product informationProduct information

management > Products> Released productsmanagement > Products> Released products . Select the item, and then click Plan > Default orderPlan > Default order

settingssettings . In the Default order settingsDefault order settings  form, see the Default order typeDefault order type field.
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This topic describes how an item that has site and warehouse as coverage dimensions is planned. The

warehouse dimension is mandatory.

This master planning scenario involves the following conditions:

The site dimension is set to mandatory and must be entered on the demand transaction.

The warehouse dimension is set to mandatory and must be entered on the demand transaction.

The site and warehouse dimensions are set for coverage planning. Other dimensions may be set for

coverage planning also. However, they are not affected by the multisite functionality.

The following graphic illustrates how master planning proceeds. The parameters that are referred to in the

graphic, and their locations, are as follows:

The warehouse is set to ManualManual . Click Inventor y management > Setup > Inventor y breakdown >Inventor y management > Setup > Inventor y breakdown >

WarehousesWarehouses . On the Master planningMaster planning FastTab, see the ManualManual  field.

Item coverage is defined for the item. Click Product information management > Products> ReleasedProduct information management > Products> Released

productsproducts . Select the item, and then, on the Action Pane, on the PlanPlan tab, click Item coverageItem coverage.

Refill relations are defined for the warehouse. Click Inventor y management > Setup > Inventor yInventor y management > Setup > Inventor y

breakdown > Warehousesbreakdown > Warehouses . On the Master planningMaster planning FastTab, see the Main warehouseMain warehouse field group.

The default order type is set to Production, Purchase order, or Kanban. Click Product informationProduct information

management > Products> Released productsmanagement > Products> Released products . Select the item, and then, on the Action Pane, on the

PlanPlan tab, click Default order settingsDefault order settings . In the Default order settingsDefault order settings  form, see the Default order typeDefault order type.
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This topic describes how an item that has site and warehouse as coverage dimensions is planned. The

warehouse dimension is not mandatory.

This master planning scenario involves the following conditions:

The site dimension is set to mandatory and must be entered on the demand transaction. This setting can't be

modified.

The warehouse dimension is not set to mandatory. The warehouse may be known, but it is not used in the

master planning calculation.

The site and warehouse dimensions are set for coverage planning. Other dimensions may be set for

coverage planning also. However, they are not affected by the multisite functionality.

The following graphic illustrates how master planning proceeds. The parameters that are referred to in the

graphic, and their locations, are as follows:

The warehouse is set to Manual. Click Inventor y management > Setup > Inventor y breakdown >Inventor y management > Setup > Inventor y breakdown >

WarehousesWarehouses . On the Master planningMaster planning FastTab, see the ManualManual  field.

Item coverage is defined for the item. Click Product information management > Products> ReleasedProduct information management > Products> Released

productsproducts . Select the item, and then, on the Action Pane, on the PlanPlan tab, click Item coverageItem coverage.

Refill relations are defined for the warehouse. Click Inventor y management > Setup > Inventor yInventor y management > Setup > Inventor y

breakdown > Warehousesbreakdown > Warehouses . On the Master planningMaster planning FastTab, see the Main warehouseMain warehouse field group.

The default order type is set to Production, Purchase order, or Kanban. Click Product informationProduct information

management > Products> Released productsmanagement > Products> Released products . Select the item, and then, on the Action Pane, on the

PlanPlan tab, click Default order settingsDefault order settings . In the Default order settingsDefault order settings  form, see the Default order typeDefault order type.
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During a demand explosion, if an item has a default order type of Production, the planning engine finds a valid

BOM version based on the site.

The site dimension is always known and is stated on the demand transaction. The following process is used to

determine the BOM version to use:

If there is a BOM version defined for the item at the demand site, the site-specific BOM is used.

If there is no site-specific BOM version defined for an item at the demand site, a general BOM is used. A

general BOM does not state a site, and it is valid for multiple sites. If there is a general BOM, it is used.

If there is no general BOM version to use, the demand explosion stops at this point.

A valid BOM version, whether site-specific or general, must meet the required criteria for date and quantity.
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https://go.microsoft.com/fwlink/?LinkId=521839
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This article explains a master planning scenario that involves explosion of a bill of materials (BOM) version.

A demand explosion of a bill of materials (BOM) version creates a demand for each BOM line item at a specific

site and, possibly, at a specific warehouse. In a site-specific BOM, a specific warehouse can be defined for each

BOM line. Additionally, for each BOM line, the item's dimension settings determine whether the warehouse is

required. The resulting demand for each BOM line item then becomes the starting point for additional demand

explosion. This master planning scenario involves the following conditions:

The site dimension is mandatory and must be entered on the demand transaction.

The site dimension is consistent. Therefore, the site for lower-level demand is the same as the site on the

initial demand transaction.

The following illustration shows how the process for master planning demand explosion. 

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/master-plan-explosion-bom-version.md


Additional resources

NOTENOTE

Determine the BOM version

Master planning and multisite functionality overview

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Negative days and dynamic negative days
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Scenario 1: You get demand before the item's lead time period

Case A: Negative days are less than the item's lead timeCase A: Negative days are less than the item's lead time

This topic provides information about negative days and dynamic negative days, and how you can use them to

help your business. The negative days time fence represents the number of days that you're willing to wait

before you order new replenishment when you have negative inventory.

In this topic, you will learn the following information:

How planned orders are created

The correlation between the negative days time fence and the item's lead time

How the dynamic negative days time fence is calculated, and how the item's lead time is factored into the

calculation

How to interpret the suggestions for improving the running time for material requirements planning (MRP)

(master planning) that are related to negative days

This topic uses three hypothetical scenarios to help you understand this information. The difference between the

scenarios is the point at which you get demand: before, during, or after the item's lead time period.

You might get demand either relatively early in your item's lead time or just before the lead time period begins.

Here is an example of this scenario:

The DemoProduct item has a six-day purchase lead time.

On day zero (January 1), the inventory level for the DemoProduct item is 0 (zero).

On day zero (January 1), you get a sales order for a quantity of 10 of the DemoProduct item.

On day seven (January 7), there is an existing purchase order for a quantity of 10 of the DemoProduct item.

The following illustration shows a graphical view of this scenario.

If you set the negative days to a number that is less than the item's lead time, MRP looks for receipts for the

DemoProduct item inside the negative days time fence. Because it doesn't find any receipts, MRP creates a new

planned purchase order. This planned order is immediately delayed by six days (the lead time). Therefore, it will

arrive on January 7. The existing purchase order gets a CancelCancel  action message, because the creation of the new

planned purchase order has made it redundant.

The following illustration shows a screenshot of this case.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/more-about-dynamic-negative-days.md
https://blogs.msdn.com/b/axmfg/archive/2015/01/02/checklist-for-improving-mrp-performance-part-2-how-to-setup-planning-parameters.aspx


Case B: Negative days are more than the item's lead timeCase B: Negative days are more than the item's lead time

Case C: Automatically correlate the item's lead time to the negative days time fenceCase C: Automatically correlate the item's lead time to the negative days time fence

Case D: Use only dynamic negative daysCase D: Use only dynamic negative days

The following illustration shows a graphical view of what occurs in this case.

If you consider MRP performance and plan nervousness, this case doesn't perform well. MRP must create a new

planned order, and must calculate delays and actions. These tasks are time-consuming. This case also adds two

more transactions to your plan. On the other hand, the sales order is delayed by only six days, not seven days.

To help improve MRP performance, you can set the negative days to a number that is more than the item's lead

time. Because you can't get the supply inside the lead time in this scenario, you can search for receipts for as

long as this search makes sense. Although the running time for MRP will be shorter, you should watch out for

additional delays to the orders.

To automatically correlate the item's lead time to the negative days time fence, use dynamic negative days. To

use dynamic negative days, go to Master planning > Setup > Master planning parametersMaster planning > Setup > Master planning parameters , and then, on

the GeneralGeneral  tab, in the CoverageCoverage section, set the Use dynamic negative daysUse dynamic negative days  option to YesYes . MRP then looks

for receipts inside the dynamic negative days time fence. This time fence is calculated by using the following

formula:

Dynamic negative days time fence = Purchase lead time + Negative days time fence + (Current date –

Requirement date)

(If the default order type of the DemoProduct item is ProductionProduction or TransferTransfer , the lead time is the inventor yinventor y

lead time.)

When dynamic negative days are used, the time fence that MRP looks at for receipts is now 6 + 2 + 0 = 8 days.

MRP finds the existing purchase order and pegs the sales order against it. No new planned orders are created.

Therefore, the running time for MRP is shorter. The following illustration shows the net requirements for the

DemoProduct item.

The following illustration shows a graphical view of what occurs in this case.

If you set the negative days to 00  (zero) and use only the dynamic negative days time fence, the dynamic negative

days time fence is 6 + 0 + 0 = 6 days. In this case, the result is the same as the result in case A for this scenario.



Case E: Use both negative days that are more than the item's lead time and the dynamic negative days timeCase E: Use both negative days that are more than the item's lead time and the dynamic negative days time
fencefence

Scenario 2: You get demand during the item's lead time period

Case A: Negative days are less than the item's lead timeCase A: Negative days are less than the item's lead time

MRP must create a new planned order, and must calculate delays and actions. These tasks are time-consuming

and can also be frustrating. You also have two more transactions to process. Because the demand can't be

fulfilled on time for the item to arrive, this case adds unnecessary complications to your plan.

The following illustration shows a screenshot for this case.

The following illustration shows a graphical view of what occurs in this case.

If you set the negative days to a number that is more than the item's lead time, and if you also use the dynamic

negative days time fence, the dynamic negative days time fence is 6 + 6 + 0 = 12 days. This approach might

produce a very long time fence that MRP must search for results in. For information about how case E is related

to a situation where you set the negative days to a long time fence, see the Conclusion section of this topic.

You might get demand sometime during your item's lead time. Here is an example of this scenario:

The DemoProduct item has a six-day purchase lead time.

On day zero (January 1), the inventory level for the DemoProduct item is 0 (zero).

On day four (January 5), which is inside the item's lead time, you get a sales order for a quantity of 10 of the

DemoProduct item.

On day seven (January 8), there is a purchase order for a quantity of 10 of the DemoProduct item.

The following illustration shows a graphical view of this scenario.

If you set the negative days to a number that is less than the item's lead time, MRP looks for receipts for the

DemoProduct item inside the negative days time fence. Because it doesn't find any receipts, MRP creates a new

planned purchase order that uses the current date as the order date. This planned order is immediately delayed

by six days (the lead time). Therefore, it will arrive on January 7. The existing purchase order gets a CancelCancel

action message, because the creation of the new planned purchase order has made it redundant.



Case B: Negative days are more than the item's lead timeCase B: Negative days are more than the item's lead time

Case C: Automatically correlate the item's lead time to the negative days time fenceCase C: Automatically correlate the item's lead time to the negative days time fence

Case D: Use only dynamic negative daysCase D: Use only dynamic negative days

Case E: Use both negative days that are more than the item's lead time and the dynamic negative days timeCase E: Use both negative days that are more than the item's lead time and the dynamic negative days time
fencefence

Scenario 3: You get demand after the item's lead time period

The following illustration shows a screenshot for this case.

The following illustration shows a graphical view of what occurs in this case.

This case resembles case B for scenario 1. If you set the negative days to a number that is more than the item's

lead time, you don't get a new planned order. The sales order is attached to the existing purchase order.

This case resembles case C for scenario 1, because dynamic negative days work just as well as they do in that

case. The dynamic negative days time fence is now 6 + 2 – 4 = 4 days. If you use this approach, MRP finds the

existing purchase order and attaches the sales order to it. Because no new planned orders are created, the

running time for MRP is shorter.

The following illustration shows a screenshot of this case.

The following illustration shows a graphical view of what occurs in this case.

If you set the negative days to 00  (zero) and use only the dynamic negative days time fence, the dynamic negative

days time fence is now 6 + 0 – 4 = 2 days. In this case, the result is the same as the result in case A for this

scenario. For a graphical view of what occurs, see case A for this scenario.

If you set the negative days to a number that is more than the item's lead time, and if you also use the dynamic

negative days time fence, the dynamic negative days time fence is 6 + 6 – 4 = 8 days. This approach might

produce a very long time fence that MRP must search for results in. For information about how case E is related

to a situation where you set the negative days to a long time fence, see the Conclusion section of this topic.



Case A: Negative days are less than the item's lead timeCase A: Negative days are less than the item's lead time

NOTENOTE

Case B: Negative days are more than the item's lead timeCase B: Negative days are more than the item's lead time

You might get demand after the item's lead time. Here is an example of this scenario:

The DemoProduct item has a six-day purchase lead time.

On day zero (January 1), the inventory for the DemoProduct item is 0 (zero).

On day seven (January 8), which is outside the item's lead time, you get a sales order for a quantity of 10 of

the DemoProduct item.

On day 10 (January 11), there is a purchase order for a quantity of 10 of the DemoProduct item.

The following illustration shows a graphical view of this scenario.

If you set the negative days to a number that is less than the item's lead time, MRP looks two days ahead of the

sales order's requirement date. Because it doesn't find anything, MRP creates a planned purchase order on

January 2. This planned purchase order will be shipped just in time to fulfill the sales order demand. The existing

purchase order gets a CancelCancel  action message, because it isn't required.

The following illustration shows a screenshot of this case.

The following illustration shows a graphical view of what occurs in this case.

In the preceding screenshot, the purchase order requirement date is January 12. Because that screenshot was taken in

2015, when January 11 was a Sunday, MRP moved the requirement date to the next working day, which was Monday,

January 12. Nevertheless, the purchase order has a delivery date of January 11.

If you set the negative days to a number that is more than the item's lead time, you don't get a new planned

order. The sales order is pegged against the existing purchase order. Therefore, the sales order is delayed. If you

create a planned order, you can ship the sales order on time.

The following illustration shows a screenshot of this case.



  

Case C: Automatically correlate the item's lead time to the negative days time fenceCase C: Automatically correlate the item's lead time to the negative days time fence

Case D: Use only dynamic negative daysCase D: Use only dynamic negative days

Case E: Use both negative days that are more than the item's lead time and the dynamic negative days timeCase E: Use both negative days that are more than the item's lead time and the dynamic negative days time
fencefence

Conclusion

The following illustration shows a graphical view of what occurs in this case.

This case resembles case C for scenario 1, because dynamic negative days work just as well as, if not better than,

they work in case B for this scenario.

The dynamic negative days time fence is 6 + 2 – 7 = 1 day. However, in this case, the system still considers the

negative days lead time (2), because MRP considers the maximum value between the negative days lead time

and the dynamic negative days lead time. Therefore, the result in this case is the same as the result in case A for

this scenario.

The following illustration shows a graphical view of what occurs in this case.

If you set the negative days to 00  (zero) and use only the dynamic negative days time fence, the dynamic negative

days time fence is now 6 + 0 – 7 = -1 day. In this case, the system still considers the negative days lead time (2).

Therefore, the result in this case is the same as the result in case A for this scenario and has all the same

drawbacks. For a graphical view of what occurs, see case A for scenario 2.

This case is the same as case E for scenarios 1 and 2. It has basically the same benefits and drawbacks.

As the three scenarios in this topic show, it's a good idea to set the negative days to a number that is more than

the lead time of the items in the coverage group. It's also a good idea to use only dynamic negative days, and to

set the negative days to the number of days that you're willing to wait before you order new replenishment

when you have negative inventory (in other words, the number of days that you're willing to further delay

demand). Additionally, items in the same coverage group should have similar lead times.

If you set the negative days to 00  (zero) and don't use dynamic negative days, MRP always creates a new planned

order to fulfill demand. In this situation, it's important that you work with the action messages to make sure that

you don't pile up inventory.

You might want to set the negative days to a long time fence and then work with the action messages. This

approach produces good planning results, but it's also a bit slower. It might also be more difficult to analyze,



See also

because you must analyze and apply the action messages. Here is an example:

The DemoProduct item has a six-day purchase lead time.

On day zero (January 1), the inventory for the DemoProduct item is 0 (zero).

On day zero (January 1), you get a sales order for a quantity of 10 of the DemoProduct item.

On day 10 (January 10), you get a sales order for a quantity of 10 of the DemoProduct item.

On day 12 (January 12), there is a purchase order for a quantity of 10 of the DemoProduct item.

Negative days are set to 2020 , which is much more than the item's lead time.

The following illustration shows a graphical view of what occurs.

MRP produces the following results.

In the preceding screenshot, the sales order requirement date is January 9 instead of January 10. Because that

screenshot was taken in 2015, when January 10 was a Saturday, the requirement date of the order should be

the previous working day, which was Friday, January 9.

MRP creates a planned purchase order to fulfill the demand that is requested by the first sales order, but then it

also recommends that you cancel the planned order, because you can advance the existing purchase order and

increase the quantity on it.

The results aren't wrong, but the running time for MRP might be longer, because MRP must create all the delays

and suggestions. Additionally, the planner might require more time to understand the MRP results. Most

importantly, in this case, it's essential that the planner understand and use the action messages.

If you reduce the negative days to a number that's closer to the item's lead time, and you use dynamic negative

days, MRP produces the following results.

MRP creates a planned order that is attached to the first sales order. Then, as is expected, the second sales order

is pegged against the existing purchase order, based on the negative days setting. This planning result is also

correct, and the running time for MRP might be shorter. In this case, it isn't essential that you understand and

know how to work with the action messages.

To help guarantee that the correct values are entered for your business, you must think in terms of both

functionality and MRP running time. Therefore, it can take a little trial and error to determine the optimal values.

For more discussion, see the original More about (dynamic) negative days blog post.

https://blogs.msdn.microsoft.com/axmfg/2015/02/19/more-about-dynamic-negative-days/
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Create an intercompany plan
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Set up an intercompany planning group

Create an intercompany plan

View the result of the plan

NOTENOTE

This procedure shows how to create an intercompany plan. The demo data company used to create this

procedure is USMF.

1. In the Navigation paneNavigation pane, go to Modules > Master planning > Setup > Intercompany planningModules > Master planning > Setup > Intercompany planning

groupsgroups .

2. Use the Quick Filter to find records. For example, filter on the Name field with a value of '10'.

3. In the list, mark the selected row.

4. Click DeleteDelete. This step is necessary in order to shorten the intercompany planning run. Intercompany

planning will run master planning in all the companies in a planning group, starting from the lowest

scheduling sequence.

5. Click YesYes .

6. Close the page.

1. In the Navigation paneNavigation pane, go to Modules > Master planning > Workspaces > Master planningModules > Master planning > Workspaces > Master planning.

2. Click Intercompany master planningIntercompany master planning.

3. In the Intercompany planning groupIntercompany planning group field, click the drop-down button to open the lookup.

4. In the list, click the link in the selected row. Select intercompany planning group 10.

5. In the Number of intercompany planning iterationsNumber of intercompany planning iterations  field, enter '2'. Intercompany planning group 10

has two members. In order to propagate the delays from the source company (USMF) to the customer

company (DEMF), you will need to run intercompany in both companies two times. The first iteration will

propagate the demand and identify the delays in the source company (USMF). The second iteration will

propagate the delays from USMF to DEMF.

6. In the First iterationFirst iteration field, select 'Regeneration'.

7. In the Subsequent iterationsSubsequent iterations  field, select 'Regeneration'.

8. In the Number of threadsNumber of threads  field, enter a number. This represents the number of parallel threads used for

planning.

9. Click OKOK.

1. In the PlanPlan field, click the drop-down button to open the lookup.

2. In the list, click the link in the selected row. Click the link for StaticPlan. You need to be in company USMF.

3. Click Planned ordersPlanned orders .

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/tasks/create-intercompany-plan.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

This procedure shows how to view all the planned orders that will be fulfilled by an intercompany vendor. The

demo data company used to create this procedure is DEMF.

1. Click Master planning.

2. In the Plan field, enter or select a value.

3. Click Run.

4. In the Number of threads field, enter a number.

5. Click OK.

6. Click Planned intercompany demand.

7. Click Outbound planned intercompany demand.

8. Expand the Upstream demand details section.

In the Plan field, select plan 10.

This represents the number of parallel threads to be used for master planning.

This may take a while.

This page provides an overview of all the planned demand that will be fulfilled by an internal supply

chain vendor.

In this section, you can see the details about how the demand will be fulfilled. You may need to wait

for master planning to be run in the supply company before you can see additional information here.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/tasks/view-outbound-planned-intercompany-demand.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

This procedure shows how to view all the planned orders that will be fulfilled by an intercompany vendor. The

demo data company used to create this procedure is DEMF.

1. Click Master planning.

2. In the Plan field, enter or select a value.

3. Click Run.

4. In the Number of threads field, enter a number.

5. Click OK.

6. Click Planned intercompany demand.

7. Click Outbound planned intercompany demand.

8. Expand the Upstream demand details section.

In the Plan field, select plan 10.

This represents the number of parallel threads to be used for master planning.

This may take a while.

This page provides an overview of all the planned demand that will be fulfilled by an internal supply

chain vendor.

In this section, you can see the details about how the demand will be fulfilled. You may need to wait

for master planning to be run in the supply company before you can see additional information here.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/tasks/collaborate-internal-supply-chain-customers.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

Key features of demand forecasting

Major themes in demand forecasting

Demand forecasting is used to predict independent demand from sales orders and dependent demand at any

decoupling point for customer orders. The enhanced demand forecast reduction rules provide an ideal solution

for mass customization.

To generate the baseline forecast, a summary of historical transactions is passed to Microsoft Azure Machine

Learning hosted on Azure. Because this service isn't shared among users, it can easily be customized to meet

industry-specific requirements. You can use Supply Chain Management to visualize the forecast, adjust the

forecast, and view key performance indicators (KPIs) about forecast accuracy.

Microsoft Azure Machine Learning Studio (classic) is required for forecast generation with machine learning. As of January

2021, it is available in Japan East, South Central US, Southeast Asia, West Central US, and West Europe. For updated

information about current availability, see Azure Products by Region.

Here are some of the main features of demand forecasting:

Generate a statistical baseline forecast that is based on historical data.

Use a dynamic set of forecast dimensions.

Visualize demand trends, confidence intervals, and adjustments of the forecast.

Authorize the adjusted forecast to be used in planning processes.

Remove outliers.

Create measurements of forecast accuracy.

Three major themes are implemented in demand forecasting:

Modular ityModular ity  – Demand forecasting is modular and easy to configure. You can turn the functionality on and

off by changing the configuration key at TradeTrade > Inventor y forecastInventor y forecast > Demand forecastingDemand forecasting.

Reuse of the Microsoft stackReuse of the Microsoft stack – Machine Learning, which is part of the Microsoft Cortana Analytics Suite,

lets you quickly and easily create predictive analysis experiments, such as demand estimation experiments,

by using algorithms R or Python programming languages and a simple drag-and-drop interface.

You can download the Demand forecasting experiments, change them to meet your business

requirements, publish them as a web service on Azure, and use them to generate demand forecasts.

The experiments are available for download if you've purchased a Supply Chain Management

subscription for a production planner as enterprise-level user.

You can download any of the currently available demand prediction experiments from the Cortana

Analytics Gallery. Whereas the Demand forecasting experiments are automatically integrated with

Supply Chain Management, customers and partners must handle the integration of experiments that

they download from the Cortana Analytics Gallery. Therefore, experiments from the Cortana Analytics

Gallery aren't as straightforward to use as the Finance and Operations Demand forecasting

experiments. You must modify the code of the experiments so that they use the Finance and

Operations application programming interface (API).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/introduction-demand-forecasting.md
https://azure.microsoft.com/global-infrastructure/services/?regions=all&products=machine-learning-studio
https://gallery.cortanaanalytics.com/
https://gallery.cortanaanalytics.com/
https://gallery.cortanaanalytics.com/


Basic flow in demand forecasting

Limitations

Demand forecast variant conversion limitationDemand forecast variant conversion limitation

Forecast reduction at any decoupling pointForecast reduction at any decoupling point – Demand forecasting in builds on this functionality, which

lets you forecast both dependent and independent demand at any decoupling point.

You can create your own experiments in Microsoft Azure Machine Learning Studio (classic), publish

them as services on Azure, and use them to generate demand forecasts.

If you don’t require high performance, or if you don't require that a large amount of data be

processed, you can use the Machine Learning free tier. We recommend that you always start from this

tier, especially during implementation and testing phases. If you require higher performance and

additional storage, you can use the Machine Learning standard tier. This tier requires an Azure

subscription and involves additional costs. For details about Machine Learning pricing, see Machine

Learning Studio pricing.

The following diagram shows the basic flow in demand forecasting.

Demand forecast generation starts in Supply Chain Management. Historical transactional data from the Supply

Chain Management transactional database is gathered and populates a staging table. This staging table is later

fed to a Machine Learning service. By performing minimal customization, you can plug various data sources into

the staging table. The data sources can include Microsoft Excel files, comma-separated value (CSV) files, and

data from Microsoft Dynamics AX 2009 and Microsoft Dynamics AX 2012. Therefore, you can generate demand

forecasts that consider historical data that is spread among multiple systems. However, the master data, such as

item names and units of measure, must be the same across the various data sources.

If you use the Demand forecasting Machine Learning experiments, they look for a best fit among five time series

forecasting methods to calculate a baseline forecast. The parameters for these forecasting methods are

managed in Supply Chain Management.

The forecasts, historical data, and any changes that were made to the demand forecasts in previous iterations

are then available in Supply Chain Management.

You can use Supply Chain Management to visualize and modify the baseline forecasts. Manual adjustments

must be authorized before the forecasts can be used for planning.

Demand forecasting is a tool that helps customers in the manufacturing industry create forecasting processes. It

offers the core functionality of a demand forecasting solution and is designed so that it can easily be extended.

Demand forecasting might not be the best fit for customers in industries such as commerce, wholesale,

warehousing, transportation, or other professional services.

Unit of measure (UOM) per variant conversion is not fully supported when generating demand forecast if

inventory UOM is different than the demand forecast UOM.

https://aka.ms/machine-learning-price-info
file:///T:/eiye/ac1a/dynamics365/supply-chain/master-planning/media/demand-forecasting-introduction.png


Additional resources

NOTENOTE

Generating forecast (Inventor y UOM > Demand forecast UOMInventor y UOM > Demand forecast UOM) uses product UOM conversion. When

loading historical data for the demand forecast generation, the product level UOM conversion will be always

used when converting from inventory UOM to the demand forecast UOM, even if there are conversions defined

on the variant level.

The first part of authorizing forecast (Demand forecast UOM > Inventor y UOMDemand forecast UOM > Inventor y UOM) uses product UOM

conversion. The second part of authorizing forecast (Inventor y UOM > Sales UOMInventor y UOM > Sales UOM) uses the variant UOM

conversion. When the generated demand forecast is authorized, the conversion to inventory UOM from demand

forecast UOM will be done using product level UOM conversion. At the same time, conversion between the

inventory unit and the sales UOM will respect the variant level defined conversions.

Note that the demand forecast UOM does not have to have any specific meaning. It can be defined as “Demand

forecast unit”. For each of the products, you can define the conversion to be 1:1 with the inventory UOM.

Demand forecasting setup

Generate a statistical baseline forecast

Make manual adjustments to the baseline forecast

Authorize an adjusted forecast

Monitor forecast accuracy

Remove outliers from historical transaction data when calculating a demand forecast

Extend the demand forecasting functionality

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://www.youtube.com/watch?v=4OIKIXLiNjI&feature=youtu.be
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Item allocation key

Intercompany planning groups

Demand forecasting parameters

This topic describes the setup tasks that you must perform to prepare for demand forecasting.

The setup tasks include setting up the following data and parameters.

A demand forecast is calculated for an item and its dimensions only if the item is part of an item allocation key.

This rule is enforced to group large numbers of items, so that demand forecasts can be created more quickly.

The item allocation key percentage is ignored when demand forecasts are generated. Forecasts are created

based on historical data only.

An item and its dimensions must be part of only one item allocation key if the item allocation key is used during

forecast creation.

To add a stock keeping unit (SKU) to an item allocation key, go to Master planningMaster planning > SetupSetup > DemandDemand

forecastingforecasting > Item allocation keysItem allocation keys . Use the Assign itemsAssign items page to assign an item to an allocation key.

Demand forecasting generates cross-company forecasts. In Dynamics 365 Supply Chain Management,

companies that are planned together are grouped into one intercompany planning group. To specify, per

company, which item allocation keys should be considered for demand forecasting, associate an item allocation

key with the intercompany planning group member by going to Master planningMaster planning > SetupSetup > IntercompanyIntercompany

planning groupsplanning groups .

By default, if no item allocation keys are assigned to intercompany planning group members, a demand forecast

is calculated for all items that are assigned to all item allocation keys from all companies. Additional filtering

options for companies and item allocation keys are available on the Generate statistical baseline forecastGenerate statistical baseline forecast

page.

Review the number of items that are forecasted. Unnecessary items might cause increased costs when you use

Microsoft Azure Machine Learning.

To set up demand forecasting parameters, go to Master planningMaster planning > SetupSetup > Demand forecastingDemand forecasting

parametersparameters . Because demand forecasting runs cross-company, the setup is global. In other words, the setup

applies to all companies.

Demand forecasting generates the forecast in quantities. Therefore, the unit of measure that the quantity should

be expressed in must be specified in the Demand forecast unitDemand forecast unit field. The unit of measure must be unique, to

help guarantee that the aggregation and percentage distribution make sense. For more information about

aggregation and percentage distribution, see Make manual adjustments to the baseline forecast. For every unit

of measure that is used for SKUs that are included in demand forecasting, make sure that there is a conversion

rule for the unit of measure and the general forecasting unit of measure. When forecast generation is run, the

list of items that don't have a unit of measure conversion is logged, so that you can easily correct the setup.

Demand forecasting can be used to forecast both dependent and independent demand. For example, if only the

Sales orderSales order  check box is selected, and if all the items that are considered for demand forecasting are items that

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/demand-forecasting-setup.md
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Settings for the demand forecasting machine learning service

Forecast algorithm parametersForecast algorithm parameters

are sold, the system calculates independent demand. However, critical subcomponents can be added to item

allocation keys and included in demand forecasting. In this case, if the Production lineProduction line check box is selected, a

dependent forecast is calculated.

There are two methods for creating a baseline forecast. You can use forecasting models on top of historical data,

or you can just copy over the historical data to the forecast. The Forecast generation strategyForecast generation strategy  field lets you

select between these two methods. To use forecast models, select Azure Machine LearningAzure Machine Learning.

By clicking Forecast dimensionsForecast dimensions  in the left pane of the Demand forecasting parametersDemand forecasting parameters  page, you can

also select the set of forecast dimensions to use when the demand forecast is generated. A forecast dimension

indicates the level of detail that the forecast is defined for. Company, site, and item allocation key are mandatory

forecast dimensions, but you can also generate forecasts at the warehouse, inventory status, customer group,

customer account, country/region, state, and item plus all item dimension levels.

At any point, you can add forecast dimensions to the list of dimensions that are used for demand forecasting.

You can also remove forecast dimensions from the list. However, manual adjustments are lost if you add or

remove a forecast dimension.

Not all items behave in the same manner from a demand forecasting perspective. Similar items can be grouped

in one item allocation key, and parameters such as transaction types and forecast method settings can be set per

item allocation key. Click Item allocation keysItem allocation keys  in the left pane of the Demand forecasting parametersDemand forecasting parameters

page.

To generate the forecast, Supply Chain Management uses a Machine Learning web service. To connect to the

service, you must provide the following information if you sign in to Microsoft Azure Machine Learning Studio

(classic):

Web service application programming interface (API) key

Web service endpoint URL

Azure storage account name

Azure storage account key

The Azure storage account name and key are required only if you use a custom storage account. If you deploy the on-

premises version, you must have a custom storage account on Azure, so that Machine Learning can access the historical

data.

To create demand predictions, you can deploy your own service by using Machine Learning Studio or the Supply

Chain Management demand forecasting experiments. Instructions for deploying the demand forecasting

experiments as a web service are available in Supply Chain Management. On the Demand forecastingDemand forecasting

parametersparameters  page, click the Azure Machine LearningAzure Machine Learning tab.

To view the parameters that can be configured for the demand forecasting service, go to Master PlanningMaster Planning >

SetupSetup > Demand forecastingDemand forecasting > Forecasting algorithm parametersForecasting algorithm parameters . The Forecasting algorithmForecasting algorithm

parametersparameters  page shows the default values for the parameters. You can overwrite these parameters on the

Demand forecasting parametersDemand forecasting parameters  page. Use the GeneralGeneral  tab to overwrite the parameters globally, or use the

Item allocation keysItem allocation keys  tab to overwrite the parameters per item allocation key. Parameters that are overwritten

for an item allocation key affect only the forecast of items that are associated with that item allocation key.

On the Allocation keysAllocation keys  tab you can set the Forecast algorithm parametersForecast algorithm parameters  for each item allocation key. The

following options are available.
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Confidence level percentageConfidence level percentage: A confidence interval consists of a range of values that act as good

estimates for the demand forecast. A 95% confidence level percentage indicates there is a 5% risk that the

future demand falls outside the confidence interval range.

Force seasonalityForce seasonality : Specifies whether to force the model to use a certain type of seasonality. Applies to

ARIMA and ETS only. Options: AUTO(default), NONE, ADDITIVE, MULTIPLICATIVE.

Forecasting modelForecasting model : Options: ARIMA, ETS, STL, ETS+ARIMA, ETS+STL, ALL. To select best fit model, use ALLALL .

Maximum forecasted valueMaximum forecasted value: Specifies the maximum value to use for predictions. Format: +1E[n] or

numeric constant.

Minimum forecasted valueMinimum forecasted value: Specifies the minimum value to use for predictions. Format: -1E[n] or numeric

constant.

Missing value substitutionMissing value substitution: Specifies how gaps in historical data are filled. Options: numeric value, MEAN,

PREVIOUS, INTERPOLATE LINEAR, INTERPOLATE POLYNOMIAL.

Missing value substitution scopeMissing value substitution scope: Specifies whether the value substitution applies only to the data range

of each individual granularity attribute, or to the entire dataset. Options: GRANULARITY_ATTRIBUTE(default),

GLOBAL.

Seasonality hintSeasonality hint: For seasonal data, provide a hint to the forecasting model to improve forecast accuracy.

Format: integer number, representing the number of buckets a demand pattern repeats itself. For example,

enter "6" for data that repeats itself every 6 months.

Test set size percentageTest set size percentage: Percentage of historical data to be used as a test set for forecast accuracy

calculation.

Demand forecasting overview

Generate a statistical baseline forecast

Make manual adjustments to the baseline forecast
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Example
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To help guarantee the accuracy of demand forecasts, you must have as much historical demand data as you can

get per item or item allocation key. If the historical demand data isn't already imported, use the Histor icalHistor ical

external demandexternal demand (ReqDemPlanHistoricalExternalDemandEntity) data entity in Dynamics 365 Supply Chain

Management to import it.

In the Data managementData management workspace, you can see an overview of all the fields in the entity.

1. Open the Data managementData management workspace.

2. Select the Data entitiesData entities  tile.

3. Search the entity list for Histor ical external demandHistor ical external demand.

4. Select Target fieldsTarget fields . The following entity fields are mandatory: site (Deliver ingSiteIdDeliver ingSiteId), date

(DemandDateDemandDate), quantity (DemandQuantityDemandQuantity ), and either item number (ItemNumberItemNumber ) or item allocation

key (ProductAllocationKeyIdProductAllocationKeyId).

To use the data entity, you must have a Microsoft Excel file or comma-separated values (CSV) file that contains

the historical demand data. The following example shows how to import the data from a CSV file.

For more information about how to import data, including how to clean up data after an import, see Data

import and export jobs overview and its related topics.

You can use the following file as an example. Download the HistoricalDemandData. This file contains the

historical demand data for item D0001. It contains only the following mandatory fields: site, quantity, and the

demand date.

1. Select the company to import the historical demand data into.

2. Open the Data managementData management workspace.

3. Select the Impor tImpor t tile.

4. Enter a name for the import project, such as Impor t histor ical demand for item D0001Impor t histor ical demand for item D0001 .

5. In the Source data formatSource data format field, select the file format of the file that you're importing. To import the

HistoricalDemandData file for this example, select CSVCSV.

6. In the Entity nameEntity name field, select Histor ical external demandHistor ical external demand.

7. Save the file to your computer, and then upload it.

8. Select Impor tImpor t.

9. The Execution summar yExecution summar y  page is opened automatically. Verify the imported data on the page.

After you've imported the historical demand data, you can generate a demand forecast.

Generate a statistical baseline forecast

Data import and export jobs overview

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/import-historical-data.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/data-import-export-job
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This topic provides information about the parameters and filters that are used in the calculation of demand

forecasting.

When you create a baseline forecast, you must first specify the parameters and filters that are used in the

calculation. For example, you can create a baseline forecast that estimates demand based on transaction data

from the past year for a specific company, for the coming month, and for a selected group of items.

To generate a demand forecast, go to Master planning > Forecasting > Demand forecasting > GenerateMaster planning > Forecasting > Demand forecasting > Generate

statistical baseline forecaststatistical baseline forecast.

The forecast bucket can be selected at forecast generation time. The available values are: Day, Week, and Month.

The number of buckets to generate a forecast for is set in the Forecast horizonForecast horizon field.

When the forecast strategy is set to Copy over histor ical demandCopy over histor ical demand, the end of the historical horizon is

ignored. The system copies the number of buckets specified in the Forecast horizonForecast horizon field to the forecast

demand, starting from the date set in the From dateFrom date field under Histor ical horizonHistor ical horizon. By copying historical

demand from a certain date forward, production planners can make the plan for the next quarter in two ways:

By copying the demand from the same quarter last year.

By copying the demand from the previous quarter.

To prevent confusion in the production plans, a certain number of forecast buckets can be frozen. This number is

set in the Freeze time fenceFreeze time fence field. On the Adjusted demand forecastAdjusted demand forecast page, the cells for the frozen buckets

are disabled, to give a visual indication that those values should not be changed.

The start date for the baseline demand forecast doesn’t have to be the current date or a date in the future. To set

a different start date, use the Baseline forecast star t date - From dateBaseline forecast star t date - From date field. For example, in June, users can

generate a forecast for the next year. Because the forecast buckets between the end of historical demand and the

start of the baseline are missing, the predictions might not be accurate. If you are using the Demand forecasting

service, there are four ways in which you can fill in the missing gaps. You can choose the method that you want

by setting the MISSING_VALUE_SUBSTITUTION parameter on the Demand forecasting parametersDemand forecasting parameters  page.

Missing value substitution only works for the gaps in data in between the start and end dates for historical data. It will

not fill in data before or after the last physical data point, it only acts as extrapolation between actual existing data points.

The Baseline forecast star t dateBaseline forecast star t date - From dateFrom date field has to be set to the beginning of a forecast bucket, for

example, in the United States, a Sunday if the forecasting bucket is the week. The system automatically adjusts

the Baseline forecast star t dateBaseline forecast star t date - From dateFrom date field to match the beginning of a forecast bucket.

The Baseline forecast star t dateBaseline forecast star t date - From dateFrom date field can be set to a date in in the past. In other words, it is

possible to generate a demand forecast in the past. This is useful, because it lets users adjust the forecast service

parameters so that the statistical forecast generated in the past matches the actual historical demand. Users can

then continue using these parameter settings to generate a statistical baseline forecast for the future.

Manual adjustments made in previous demand forecasting iterations can be automatically applied to the new

baseline forecast if the Transfer manual adjustments to the demand forecasTransfer manual adjustments to the demand forecast check box is selected. If the

check box is cleared, the manual adjustments are not added to the baseline forecast – but they are not deleted.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/generate-statistical-baseline-forecast.md
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Manual adjustments made to a forecast can be deleted only at forecast import time, by clearing the Save theSave the

manual adjustments made to the baseline demand forecastmanual adjustments made to the baseline demand forecast check box. Manual adjustments are saved at

authorization time. Therefore, if a user makes manual adjustments to the forecast, but doesn’t authorize the

forecast back to Supply Chain Management, the changes are lost. For more information about manual

adjustments and how they work, see Authorize an adjusted forecast.

A demand forecast generation can have a name and comments to help users identify the forecast that has been

generated. These values are visible in forecast generation history on the Statistical baseline forecastStatistical baseline forecast

generation histor ygeneration histor y  page.

The intercompany planning group, item allocation keys, and other filters can be applied at forecast generation

time. These can be used to improve performance or to split the data into manageable chunks. However, note

that a demand forecast is not generated for the members of any item allocation key that is not associated with

an intercompany planning group, even if the item allocation key is selected in the query.

Sometimes users might receive errors while generating a demand forecast, or forecast generation is completed with no

session log. This can happen because of leftover data in the query that was previously used for forecast generation. To

resolve this issue, click SelectSelect  to open the Quer yQuer y  page, select ResetReset , and then regenerate the baseline forecast.

If the forecast is not generated for a big set of items, but, for example, for one item or one item allocation key at

a time, then in order to get better performance, you can select the Use request response modeUse request response mode check box on

the Master planning - Setup - Demand forecastingMaster planning - Setup - Demand forecasting - Demand forecasting parameters - AzureDemand forecasting parameters - Azure

Machine LearningMachine Learning tab.

A potentially flat looking forecast can be due to the historical data that has to be of a longer historical timeframe (a

minimum 3 of time periods in order to pick out patterns, such as 3 years with monthly forecast). To get a better result,

you can try changing the granularity of the time range or increase the time range.

Demand forecasting setup

Make manual adjustments to the baseline forecast

Authorize an adjusted forecast
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Grid on the Adjusted demand forecast page

Forecast aggregation and de-aggregation

Viewing details of the forecast

This topic explains how you can make manual adjustments to a baseline forecast and view details of the

forecast.

Before you make manual adjustments, it's important that you understand a few concepts on various pages.

The Adjusted demand forecastAdjusted demand forecast page includes a grid that has the following structure:

The first column shows the items, item allocation keys, companies, and so on, that the forecast has been

generated for. The subtitle of the page provides a description of the current forecast dimensions that are

shown in the grid. For example, if the subtitle of the page is Company / S ite / Item allocation keyCompany / S ite / Item allocation key , and

one of the row headers in the grid is USMF / 1 / D_AllocUSMF / 1 / D_Alloc, that row shows the forecast for the USMF

company, site 1, and the D_AllocD_Alloc item allocation key.

Subsequent columns represent the forecast buckets that the forecast has been generated for. Each column

header is the first date of the forecast bucket that the column shows.

The values in the cells represent the forecast for one item, item allocation key, and so on, for that specific

forecast bucket.

The subtitle of the page shows the level of forecast aggregation.

For example, if the subtitle of the page is Company / S ite / Allocation key / Item number / Color / S ize /Company / S ite / Allocation key / Item number / Color / S ize /

Configuration / StyleConfiguration / Style, there is no forecast aggregation, and the forecast is shown at the level of the item and

its dimensions. To change the aggregation, use the Change forecast dimensionsChange forecast dimensions  page, which you can open

from the application menu.

To modify the forecast, click in any of the cells that are available, and type the adjusted forecast value. The edited

cell immediately becomes bold to indicate that the forecast that it shows isn't the forecast that the demand

forecasting service created, but has been manually adjusted.

If you change the aggregation to make the page show more aggregated data, you can use the DemandDemand

forecast linesforecast lines  page to see the individual forecast lines that make up the aggregated forecast.

For example, you've generated the forecast at the item level, but you know that the demand for this item will

increase across all sites because of a promotion or another similar event. In this case, you can set the

aggregation to Company / Item allocation key / ItemCompany / Item allocation key / Item on the Change forecast dimensionsChange forecast dimensions  page. You can

adjust the global forecast for the item across all sites in the Adjusted demand forecastAdjusted demand forecast grid. To see the effect

of your change across all sites, open the Demand forecast linesDemand forecast lines  page. On this page, you will see one line for

the item for each site, the adjusted forecast quantity, and the original forecast quantity.

When the adjustment of the forecasted quantity is made at an aggregated level, the system uses weighted

allocation to distribute the change among the lines that create the aggregation.

You can also make manual adjustments on the Demand forecast linesDemand forecast lines  page, by modifying either the TotalTotal

quantityquantity  value or the QuantityQuantity  cells in the de-aggregation grid.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/manual-adjustments-baseline-forecast.md
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You can open the Demand forecast detailsDemand forecast details  page to view more information about the forecast.

The Demand forecast detailsDemand forecast details  page shows the following information in graphical and tabular formats:

The historical demand that the forecast predictions are based on.

The current forecast that is used by Master planning.

The new demand forecast values and the amounts they have been manually adjusted by.

The confidence interval for the forecasted values.

The forecast model that was used to generate the forecast. If you're viewing aggregated data, you will see the

list of all the methods that were used for all the aggregated time series.

The internal model accuracy (MAPE). For more information about forecast accuracy, see Monitor forecast

accuracy.

Notes:Notes:

If you enable Forecast model selection on Demand forecast detailsForecast model selection on Demand forecast details  from Feature management, you

will be able to select the forecast models to be include, for the historical forecast, on the Demand forecastDemand forecast

detailsdetails  page.

The confidence interval that appears in the ForecastForecast section of the page represents the difference between

the confidence interval upper limit and the confidence interval lower limit. To see the values for the upper

and lower limits, hover over the chart in the Histor ical demand and forecast graphicallyHistor ical demand and forecast graphically  section.

If you use the Demand forecasting Microsoft Azure Machine Learning, you can specify the confidence level

percentage that the forecast that is generated should have. A confidence interval consists of a range of values

that act as good estimates for the demand forecast. A 95-percent confidence level percentage indicates that

there is a 5-percent risk that the demand forecast falls outside the confidence interval range.

You can also make manual adjustments to the forecast on the Demand forecast detailsDemand forecast details  page, by modifying

the values in the ForecastForecast row in the ForecastForecast section.

Monitor forecast accuracy

Generate a statistical baseline forecast
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Not all forecast data must be authorized immediately. This article explains how you can specify the period that a

forecast is authorized for. It also explains how you can authorize the forecast for specific companies and forecast

models.

Not all forecast data must be authorized immediately. You can specify the start and end dates of the period that

the forecast is authorized for. This functionality lets you freeze specific buckets.

The start and end dates that you specify must correspond to the start and end dates of the bucket that the

forecast is generated in. The system enforces this restriction and automatically adjusts the dates, if adjustment is

required.

On the DetailsDetails  tab of the AuthorizationAuthorization page, you can view details about the forecast that was most recently

generated.

You can select the companies and the forecast models to authorize the forecast for use. By default, the grid

includes all the companies that forecast demand has been created for. For each company, the forecast model

that corresponds to the current forecast plan that is set up in the master planning parameters is prefilled.

However, you can change this forecast model to any forecast model that belongs to that company. If no forecast

demand data has been generated for a selected company, you receive a warning message at import time.

It's very important that you understand how the Save the manual adjustments made to the baselineSave the manual adjustments made to the baseline

demand forecastdemand forecast check box works. If you've made manual adjustments to the statistical baseline forecast, the

adjusted values are authorized for use, even if this check box is cleared. However, the changes are discarded

after the authorization. Therefore, the next time that a forecast is generated, that forecast is only a statistical

forecast and doesn't have any manual overrides, even if Transfer manual adjustments to the demandTransfer manual adjustments to the demand

forecastforecast is selected. Therefore, you can consider the Save the manual adjustments made to the baselineSave the manual adjustments made to the baseline

demand forecastdemand forecast check box a mechanism that lets you keep or discard all manual changes.

Make manual adjustments to the baseline forecast

Monitor forecast accuracy
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This topic describes the types of forecast accuracy that Microsoft Dynamics 365 Supply Chain Management

calculates, and explains how you can view the accuracy values.

Supply Chain Management calculates the following types of forecast accuracy:

Historical forecast accuracy, by comparing the historical forecast that Master Planning uses with the historical

demand. To view the values (both absolute values and percentage values) for historical forecast accuracy,

click Show accuracyShow accuracy  on the Demand forecast detailsDemand forecast details  page.

The estimated accuracy of the forecasting model that is used to generate the predictions. You can view the

accuracy percentage under Model details - MAPEModel details - MAPE on the Demand forecast detailsDemand forecast details  page.

If you use the Demand forecasting Microsoft Azure Machine Learning, the calculation of internal model accuracy is based

on the test data set. To specify the size of the test data set, set the TEST_SET_SIZE_PERCENTTEST_SET_SIZE_PERCENT parameter on the

Demand forecasting parametersDemand forecasting parameters  page. For example, if you set the value to 2020 , the last 20 percent of the historical

data will be used to calculate the internal model accuracy.

Authorize an adjusted forecast

Remove outliers from historical transaction data when calculating a demand forecast
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This article describes how to exclude outliers from the historical data that is used to calculate a demand forecast.

By excluding outliers, you can improve forecast accuracy.

You can exclude outliers to improve forecast accuracy. This is an optional task. Here is an overview of the

process:

1. Click Master planningMaster planning > SetupSetup > Demand forecastingDemand forecasting > Outlier  removalOutlier  removal  to open the OutlierOutlier

removalremoval  page, where you can use a query to select the transactions to exclude.

2. Select the company that the query applies to, and then enter a name and description. The Quer y dateQuer y date field

is automatically set to the current date.

3. Select the ActiveActive check box to exclude the transactions that the query finds from the historical data. This

setting will take effect when you create a baseline forecast.

4. On the Outlier  removal quer yOutlier  removal quer y  page, you can add, remove, and select the criteria that define which

transactions will be excluded when the baseline forecast is calculated. For example, select a specific item or

order transaction to exclude.

5. Click Display transactionsDisplay transactions . The Outlier  transactionsOutlier  transactions  page lists the transactions that meet the criteria that

you defined in the query, and that will be excluded from the historical data when the demand forecast is

calculated.

Note:Note: You can also create a query that is based on an existing query. Select the query to copy, and then click

DuplicateDuplicate. The Quer y dateQuer y date field identifies the version. You can use the query as it is, or you can click EditEdit

quer yquer y  to modify the criteria. You can optionally modify the name and description of the new query.

Demand forecasting overview

Monitor forecast accuracy
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Methods that are used to reduce forecast requirements

NoneNone

Percent – reduction keyPercent – reduction key

Example: Percent – reduction keyExample: Percent – reduction key
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February 1,000

March 1,000

This topic provides information about the different methods that are used to reduce forecast requirements. It

includes examples of the results of each method. It also explains how to create, set up, and use a forecast

reduction key. Some methods use a forecast reduction key to reduce forecast requirements.

When you include a forecast in a master plan, you can select how the forecast requirements are reduced when

actual demand is included. Note that master planning excludes forecast requirements from the past, which

means all forecast requirements before today's date.

To include a forecast in a master plan and select the method that is used to reduce forecast requirements, go to

Master planning > Setup > Plans > Master plansMaster planning > Setup > Plans > Master plans . In the Forecast modelForecast model  field, select a forecast model. In

the Method used to reduce forecast requirementsMethod used to reduce forecast requirements  field, select a method. The following options are

available:

None

Percent – reduction key

Transactions – reduction key

Transactions – dynamic period

The following sections provide more information about each option.

If you select NoneNone, the forecast requirements aren't reduced during master scheduling. In this case, master

planning creates planned orders to supply the forecasted demand (forecast requirements). These planned

orders maintain the suggested quantity, regardless of other types of demand. For example, if sales orders are

placed, master planning creates additional planned orders to supply the sales orders. The quantity of the

forecast requirements isn't reduced.

If you select Percent - reduction keyPercent - reduction key , the forecast requirements are reduced according to the percentages and

periods that are defined by the reduction key. In this case, master planning creates planned orders where the

quantity is calculated as forecasted quantity × reduction key in each period. If there are other types of demand,

master planning also creates planned orders to supply that demand.

This example shows how a reduction key reduces demand forecast requirements according to the percentages

and periods that are defined by the reduction key.

For this example, you include the following demand forecast in a master plan.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/reduction-keys.md


April 1,000

M O N T HM O N T H DEM A N D F O REC A STDEM A N D F O REC A ST

C H A N GEC H A N GE UN ITUN IT P ERC EN TP ERC EN T

1 Month 100

2 Month 75

3 Month 50

4 Month 25

M O N T HM O N T H P L A N N ED O RDER Q UA N T IT YP L A N N ED O RDER Q UA N T IT Y C A L C UL AT IO NC A L C UL AT IO N

January 0 = 0% × 1,000

February 250 = 25% × 1,000

March 500 = 50% × 1,000

April 750 = 75% × 1,000

May through December 1,000 = 100% × 1,000

Transactions – reduction keyTransactions – reduction key

Example: Transactions – reduction keyExample: Transactions – reduction key

M O N T HM O N T H N UM B ER O F  P IEC ES O RDEREDN UM B ER O F  P IEC ES O RDERED

January 956

February 1,176

On the Reduction keysReduction keys  page, you set up the following lines.

You assign the reduction key to the item's coverage group. Then, on the Master plansMaster plans  page, in the MethodMethod

used to reduce forecast requirementsused to reduce forecast requirements  field, you select Percent - reduction keyPercent - reduction key .

In this case, if you run forecast scheduling on January 1, the demand forecast requirements are consumed

according to the percentages that you set up on the Reduction keysReduction keys  page. The following requirement

quantities are transferred to the master plan.

If you select Transactions - reduction keyTransactions - reduction key , the forecast requirements are reduced by the transactions that

occur during the periods that are defined by the reduction key.

This example shows how actual orders that occur during the periods that are defined by the reduction key

reduce demand forecast requirements.

For this example, you select Transactions - reduction keyTransactions - reduction key  in the Method used to reduce forecastMethod used to reduce forecast

requirementsrequirements  field on the Master plansMaster plans  page.

The following sales orders exist on January 1.



March 451

April 119

M O N T HM O N T H N UM B ER O F  P IEC ES O RDEREDN UM B ER O F  P IEC ES O RDERED

M O N T HM O N T H N UM B ER O F  P IEC ES REQ UIREDN UM B ER O F  P IEC ES REQ UIRED

January 44

February 0

March 549

April 881

May through December 1,000

Transactions – dynamic periodTransactions – dynamic period

Example 1: Transactions – dynamic periodExample 1: Transactions – dynamic period

DAT EDAT E DEM A N D F O REC A STDEM A N D F O REC A ST

January 1 1,000

February 1 1,000

If you use the same demand forecast of 1,000 pieces per month that was used in the previous example, the

following requirement quantities are transferred to the master plan.

If you select Transactions - dynamic periodTransactions - dynamic period, the forecast requirements are reduced by the actual order

transactions that occur during the dynamic period. The dynamic period covers the current forecast dates and

ends at the start of the next forecast. In this case, master planning creates planned orders to supply the

forecasted demand (forecast requirements). However, when actual order transactions are placed, the forecast

requirements are reduced. The actual transactions consume part of the forecasted requirements.

When this option is used, the following behavior occurs:

Reduction keys aren't required or used.

If the forecast is completely reduced, the forecast requirements for the current forecast become 0 (zero).

If there is no future forecast, forecast requirements from the last forecast that was entered are reduced.

Time fences are included in the forecast reduction calculation.

Positive days are included in the forecast reduction calculation.

If actual order transactions exceed the forecasted requirements, the remaining transactions aren't forwarded

to the next forecast period.

Here a simple example that shows how the Transactions - dynamic periodTransactions - dynamic period method works.

For this example, you include the following demand forecast in a master plan.

You also create the following sales orders.



DAT EDAT E SA L ES O RDER Q UA N T IT YSA L ES O RDER Q UA N T IT Y

January 15 200

February 15 400

DEM A N D F O REC A ST  DAT EDEM A N D F O REC A ST  DAT E Q UA N T IT YQ UA N T IT Y EXP L A N AT IO NEXP L A N AT IO N

January 1 800 Forecast requirements (= 1,000 – 200)

January 15 200 Sales orders requirements

February 1 600 Forecast requirements (= 1,000 – 400)

February 15 400 Sales orders requirements

Example 2: Transactions – dynamic periodExample 2: Transactions – dynamic period

DAT EDAT E DEM A N D F O REC A STDEM A N D F O REC A ST

January 1 1,000

January 5 500

January 12 1,000

DAT EDAT E SA L ES O RDER Q UA N T IT YSA L ES O RDER Q UA N T IT Y

December 15 in the previous year 500

January 3 100

January 10 200

In this case, the following planned orders are created.

In most cases, systems are set up so that transactions reduce demand forecast in specific forecast periods:

weeks, months, and so on. These periods are defined in the reduction key. However, the time between two

demand forecast lines can also imply a period.

For this example, you create a demand forecast for the following dates and quantities.

Notice that, in this forecast, there isn't a clear period between the forecast dates. Between the first and second

dates there is a four-day span, and between the second and third dates there is a seven-day span. These spans

are the dynamic periods.

You also create the following sales order lines.

In this case, the forecast is reduced in the following manner :

Because the first sales order isn't in any period, it doesn't reduce any forecast.

Because the second sales order is between January 1 and January 5, it reduces the forecast for January 1 by

100.

Because the third sales order is between January 5 and January 12, it reduces the forecast for January 5 by

200.



DEM A N D F O REC A ST  DAT EDEM A N D F O REC A ST  DAT E Q UA N T IT YQ UA N T IT Y EXP L A N AT IO NEXP L A N AT IO N

December 15 in the previous year 500 Sales order requirements

January 1 900 Forecast requirements period January
1 to January 5 (= 1,000 – 100)

January 3 100 Sales order requirements

January 5 300 Forecast requirements period January
5 to January 10 (= 500 – 200)

January 12 1,000 Forecast requirements period January
12 to end

Create and set up a forecast reduction key

Use a reduction key

Therefore, the following planned orders are created.

A forecast reduction key is used in the Transactions - reduction keyTransactions - reduction key  and Percent- reduction keyPercent- reduction key  methods

for reducing forecast requirements. Follow these steps to create and set up a reduction key.

1. Go to Master planning > Setup > Coverage > Reduction keysMaster planning > Setup > Coverage > Reduction keys .

2. Select NewNew  to create a reduction key.

3. In the Reduction keyReduction key  field, enter a unique identifier for the forecast reduction key. Then, in the NameName

field, enter a name.

4. Define the periods and the reduction key percentage in each period:

The Effective dateEffective date field indicates the date when creation of the periods starts. When the Use theUse the

effective dateeffective date option is set to YesYes , the periods start on the effective date. When it's set to NoNo, the

periods start on the date when master planning is run.

Define the periods that the forecast reduction should occur during.

For a specific period, specify the percentages that the forecast requirements should be reduced by. You

can enter positive values to decrease requirements or negative values to increase requirements.

A forecast reduction key must be assigned to the coverage group of the item. Follow these steps to assign a

reduction key to an item's coverage group.

1. Go to Master planning > Setup > Coverage > Coverage groupsMaster planning > Setup > Coverage > Coverage groups .

2. On the OtherOther  FastTab, in the Reduction keyReduction key  field, select the reduction key to assign to the coverage

group. The reduction key then applies to all items that belong to the coverage group.

3. To use a reduction key to calculate forecast reduction during master scheduling, you must define this

setting in the setup of the forecast plan or the master plan. Go to one of the following locations:

Master planning > Setup > Plans > Forecast plans

Master planning > Setup > Plans > Master plans

4. On the Forecast plansForecast plans  or Master plansMaster plans  page, on the GeneralGeneral  FastTab, in the Method used to reduceMethod used to reduce

forecast requirementsforecast requirements  field, select either Percent - reduction keyPercent - reduction key  or Transactions - reductionTransactions - reduction

keykey .



Reduce a forecast by transactions

Additional resources

NOTENOTE

When you select Transactions - reduction keyTransactions - reduction key  or Transactions - dynamic periodTransactions - dynamic period as the method for

reducing forecast requirements, you can specify which transactions reduce the forecast. On the CoverageCoverage

groupsgroups  page, on the OtherOther  FastTab, in the Reduce forecast byReduce forecast by  field, select All transactionsAll transactions  if all transactions

should reduce the forecast or OrdersOrders  if only sales orders should reduce the forecast.

Master plans overview

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Create a baseline forecast
2/18/2021 • 2 minutes to read • Edit Online

Set up an item allocation key

Set up the demand forecasting parameters

Create a baseline forecast

A production planner can create a baseline forecast either by using time series forecast models or by copying

the historical demand. This procedure shows how to copy the historical demand to create a baseline forecast for

all products using one item allocation key.

1. Go to Master planning > Setup > Intercompany planning groups.

2. Use the Quick Filter to find records. For example, filter on the Name field with a value of '10'.

3. In the list, find and select the desired record.

4. Click Item allocation keys.

5. In the list, mark the selected row.

6. Click >.

7. Close the page.

8. Close the page.

Demand forecasting runs across legal entities. That's why you need to set up all the companies for

which you want to generate forecasts in one intercompany planning group.

Select all the item allocation keys for which you want to create forecasts.

Select D_Aloc item allocation key.

1. Go to Master planning > Setup > Demand forecasting > Demand forecasting parameters.

2. Expand the Forecast algorithm parameters section.

3. In the Forecast generation strategy field, select 'Copy over historical demand'.

4. Click Save.

1. Go to Master planning > Forecasting > Demand forecasting > Generate statistical baseline forecast.

2. In the From date field, enter a date.

3. In the To date field, enter a date.

4. In the From date field, enter a date.

5. Expand the Records to include section.

6. Click Filter.

7. In the list, mark the selected row.

8. In the Criteria field, type a value.

If you have sales orders starting from January 1, 2015, enter this date. If you don't, enter the earliest

date of your sales orders.

Enter the last date of your sales orders, for example '2015-03-31'.

Enter '2015-04-01'. This date will be automatically calculated as the start date of the next forecasting

bucket.

Mark the row where Field = Intercompany planning group.

Type the intercompany planning group, for example, 10, that you used in the first task.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/tasks/create-baseline-forecast.md


Visualize the demand forecast

NOTENOTE

9. In the list, find and select the desired record.

10. In the Criteria field, type a value.

11. Click OK.

12. Expand the Advanced parameters section.

13. In the Forecast bucket field, select 'Month'.

14. In the Forecast horizon field, enter '3'.

15. In the Freeze time fence field, enter '1'.

16. Click OK.

Select the row where Field = Item allocation key.

1. Go to Master planning > Forecasting > Demand forecasting > Adjusted demand forecast.

2. In the aggregated view table, select the cell in row 1, column 2. This is the second month for which you have

created forecast.

3. Set QtyCell to '400'.

4. You have made a manual adjustment to the forecast. Notice the graphical indication in the next step.

5. Click Forecast line details.

In the cell, enter a different number than the one that was forecasted, for example, 400.

In this page, you can see the accuracy values, historical demand, and forecast. You can make changes

to the forecast as well.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Modify a demand forecast manually
2/18/2021 • 2 minutes to read • Edit Online

Modify the forecast for an item

Modify the forecast in Excel

NOTENOTE

This procedure shows how to modify the forecast for an item. The demo data company used to create this

procedure is USMF. This recording is intended for the production planner.

1. In the Navigation paneNavigation pane, go to Modules > Product information management > Products >Modules > Product information management > Products >

Released productsReleased products .

2. In the list, find and select the desired record. Select the item for which you want to modify the forecast. For

example, you can select item D0001.

3. On the Action PaneAction Pane, click PlanPlan.

4. Click Demand forecastDemand forecast.

5. In the list, mark the selected row. If there are no forecast lines, create a new line by clicking New on the app

bar.

6. In the Sales quantitySales quantity  field, enter a number. This number represents the forecasted quantity for the item.

7. Click Save.

1. Click OpenOpen in Microsoft Office.

2. Click Edit Demand forecastEdit Demand forecast in Excel. In Excel, you can add, delete and edit demand forecast lines. If you are

not able to see the data in Excel, you need to sign in with the "Keep me signed in" option enabled and you

need to trust the data connection app.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/tasks/modify-demand-forecast-manually.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Troubleshoot master planning
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Bill of materials explosion behaves differently for firmed production
orders and for estimated production orders for manually created
work.
Issue descriptionIssue description

Issue resolutionIssue resolution

The Delay value isn't updated when I reschedule a planned order.

Production scheduling doesn't consider the safety margins that are
set on the item coverage for pegged supply.
Issue descriptionIssue description

Issue resolutionIssue resolution

Planned orders are generated even though we have items in stock
and production orders already exist for them.

Master planning doesn't seem to respect capacity limitations and is

This topic describes how to fix issues that you might encounter while you work with master planning.

When a production order is firmed, the items aren't exploded when you explode the bill of materials (BOM).

However, when you manually create a work order and then estimate the production order, the items are

exploded.

The system is working as expected. The explosion that occurs when the production order is firmed will point to

the planned order, but it doesn't appear that the planned order is currently firmed in this case. However, if the

production order has been estimated, the explosion is triggered from the released production order where no

planned order exists.

To update the delay for planned orders, open the ReschedulingRescheduling dialog box for the planned order. On the

ExplosionExplosion FastTab, make sure that the Perform explosion after reschedulingPerform explosion after rescheduling option is set to Yes.

Master planning considers the safety margins. However, the safety margins are ignored when planned

production orders are scheduled.

Margins are considered only during master planning, not during manual scheduling. Margins are designed to

act as a buffer during the planning phase, to give some "margin" for the actual process.

To get the desired result, you can remove the margin. The route must then be updated so that it includes the

desired time (for example, as queue time). Both master planning and manual scheduling should then produce

the same result.

You might be able to fix this issue by increasing the Positive daysPositive days  value for the relevant groups on the

Coverage groupCoverage group page. This change will cause the system to determine whether on-hand inventory can be

used for the demand. Then a new planned order won't be generated for the items that are in stock.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/master-planning/troubleshoot-masterplanning.md


scheduling more than the available capacity.
Issue descriptionIssue description

Issue resolutionIssue resolution

Planned orders take a long time to update.
Issue descriptionIssue description

Issue resolutionIssue resolution

NOTENOTE

NOTENOTE

When you use operation scheduling where there is finite capacity, and where the route specifies a mix of

requirements for both a resource group and individual resources, there is a small chance of overbooking

because of the way that the algorithm validates for capacity conflicts. This overbooking can occur when you use

helpers to run master planning. It's most likely to occur if there are many jobs that have a relatively short

runtime.

If it's essential that no overbooking occur for operation scheduling, you can make the scheduling part of master

planning single-threaded by turning on the Accurate finite capacity for Operation SchedulingAccurate finite capacity for Operation Scheduling option on

the Master planning parametersMaster planning parameters  page. This option isn't available by default. You must manually add it to the

page by using personalization features. When you use this option, scheduling will run more slowly because of

the lack of parallel processing.

When updating the requirement quantity and/or delivery date on a planned order, it typically takes at least 30

seconds per order to save the update.

This is a known issue with the built-in master planning engine. It is caused by the underlying auto explosion

through the BOM structure during edits. This issue is addressed in Planning Optimization, where a planner can

update and approve the relevant orders and, when desired, trigger a planning run to update planned orders for

the underlying BOM structure.

One way to improve performance with the built-in master planning engine is to do the following:

1. Go to Master planning > Setup > Plans > Master plansMaster planning > Setup > Plans > Master plans .

2. Select a plan.

3. Expand the Time fence in daysTime fence in days  FastTab.

4. Set ExplosionExplosion to Yes, and set the field below this setting to 0 (zero).

This will limit the period for explosions performed for this master plan to a single day.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Mobile app home page
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Overview

Elements of the mobile app

This topic describes the Finance and Operations (Dynamics 365)Finance and Operations (Dynamics 365)  mobile app and provides links to

resources that can help you implement it in your organization.

The mobile app enables your organization to make its business processes available on mobile devices. After

your IT admin enables the mobile workspaces for your organization, users can sign in to the app and

immediately begin to run business processes from their mobile devices. The mobile app includes the following

features that can help increase productivity:

Users can view, edit, and act on business data, even if they have intermittent network connectivity or their

mobile devices are completely offline. When a device reestablishes a network connection, offline data

operations are automatically synchronized.

IT admins or developers can build and publish mobile workspaces that have been tailored to their

organization. The app uses your existing code assets. Therefore, you don't have to re-implement your

validation procedures, business logic, or security configuration.

IT admins or developers can easily design mobile workspaces by using the point-and-click workspace

designer that is included with the web client.

IT admins or developers can optionally optimize the offline capabilities of workspaces by using the Business

logic extensibility framework. Because data continues to be processed while a device is offline, your mobile

scenarios remain rich and fluid, even if devices don't have constant network connectivity.

Navigation in the mobile app consists of four basic concepts: the dashboard, workspaces, pages, and actions.

1. When you start the app, you go to the dashboarddashboard.

2. On the dashboard, you can see a list of workspacesworkspaces  that have been published.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/mobile-apps/Mobile-app-home-page.md
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/mobile-apps/media/mobilephoneapp1.png


Implementation process

ST EPST EP RO L ERO L E A C T IO NA C T IO N
RESO URC ES TO  H EL P  Y O URESO URC ES TO  H EL P  Y O U
C O M P L ET E  T H E A C T IO NC O M P L ET E  T H E A C T IO N

1 System administrator Implement the Finance and
Operations app in your
organization.

3. In each workspace, you can see a list of pagespages  that are available for that workspace.

4. After you're on a page, you can perform several actions. Here are some examples:

View detailed data.

Navigate to other pages for related data, such as entity details or lines.

See a list of actionsactions  that are available for that page. Actions let you create or edit existing data.

The following illustration shows the process for implementing both mobile workspaces that are provided by

Microsoft and custom mobile workspaces.

The following table includes links to resources that can help you implement both mobile workspaces that are

provided by Microsoft and custom mobile workspaces. The numbers in the first column correspond to the

numbered steps in the previous illustration.

If you haven't yet
deployed a version
of Microsoft
Dynamics 365, see
Deploy a demo
environment.

To see a list of
mobile workspaces
that can be used,
see Mobile
workspaces recently
released.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/mobile-apps/media/mobile-implementation-process-5.png


2 System administrator If you're usingIf you're using
Microsoft Dynamics 365Microsoft Dynamics 365
for Operations versionfor Operations version
1611:1611:  Download and install
KBs that enable the mobile
workspaces that are
provided by Microsoft.

See the following topics for
more information:

3 System administrator Publish the mobile
workspaces that are
provided by Microsoft.

Publish a mobile workspace

4 Developer or independent
software vendor (ISV)

Use the mobile platform to
create custom mobile
workspaces.

Mobile platform

5 ISV Create a deployable
package that contains
custom mobile workspaces,
and upload the package to
Microsoft Dynamics
Lifecycle Services (LCS).

Create a deployable
package

6 System administrator Apply the deployable
package that contains the
custom workspaces that are
provided by the
independent software
vendor (ISV).

Apply a deployable package

7 System administrator Publish the custom mobile
workspaces that are
provided by the ISV.

Publish a mobile workspace

8 User Download and install the
mobile app.

Finance and Operations app
for Android
Finance and Operations app
for iOS
(Windows Phone
unsupported)

9 User Sign in, and use the mobile
app. The app includes the
mobile workspaces that
have been published by the
system administrator.

To see a list of mobile
workspaces that are
provided by Microsoft, see
Mobile workspaces recently
released.

ST EPST EP RO L ERO L E A C T IO NA C T IO N
RESO URC ES TO  H EL P  Y O URESO URC ES TO  H EL P  Y O U
C O M P L ET E  T H E A C T IO NC O M P L ET E  T H E A C T IO N

Cost controlling
mobile workspaces

Inventory on-hand
mobile workspace

Sales orders mobile
workspaces

Vendor collaboration
mobile workspace

Project time entry
mobile workspace

Expense
management mobile
workspace

file:///T:/eiye/ac1a/dynamics365/finance/project-management/project-time-entry-mobile-workspace.html
file:///T:/eiye/ac1a/dynamics365/finance/expense-management/expense-management-mobile-workspace.html
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/mobile-apps/platform/mobile-platform-home-page
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/deployment/create-apply-deployable-package
https://go.microsoft.com/fwlink/?linkid=850662
https://go.microsoft.com/fwlink/?linkid=850663


Troubleshooting

NOTENOTE

Mobile platform resources
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Available mobile workspaces
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M O B IL E  W O RKSPA C EM O B IL E  W O RKSPA C E DESC RIP T IO NDESC RIP T IO N AVA IL A B IL IT YAVA IL A B IL IT Y

Company directory Allows you to view and contact other
employees in your organization.

June 2017

My team You can view your direct reports and
extended staff, as well as send praise
for individuals in your reporting chain.

June 2017

Invoice approval Provides a listing of invoices that have
been assigned to you through the
vendor invoice header workflow
process.

June 2017

Expense management You can capture and upload a receipt,
so that you can attach it to an expense
report later. The mobile workspace also
lets you quickly create an expense line
by using an attached receipt.

April 2017

Purchase order approval View and respond to purchase orders
with actions such as approve or reject.

April 2017

Project time entry You can enter and save time against a
project by using your mobile device.

March 2017

Cost controlling Cost center managers can see the
performance of the cost center.

January 2017

Inventory on-hand Gain insights into reserved and
available inventory.

January 2017

Sales orders You can stay up to date on your sales
orders.

January 2017

Vendor collaboration Vendors can stay up to date on the
purchase orders that have been sent
to them for approval. They can also
view information about new and
updated purchase orders and contacts.

January 2017

This topic lists the mobile workspaces that are available for use with the Dynamics 365 for Unified Operations

mobile app.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/mobile-apps/mobile-workspaces-released.md
file:///T:/eiye/ac1a/dynamics365/finance/expense-management/expense-management-mobile-workspace.html
file:///T:/eiye/ac1a/dynamics365/finance/project-management/project-time-entry-mobile-workspace.html


Asset management This workspace lets users view and
create maintenance requests and work
orders. Users can also view the
assigned work order jobs in a calendar
or list view. Assets and functional
locations can also be viewed and
searched for.

October 2019

M O B IL E  W O RKSPA C EM O B IL E  W O RKSPA C E DESC RIP T IO NDESC RIP T IO N AVA IL A B IL IT YAVA IL A B IL IT Y
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Overview

Prerequisites

Download and install the mobile app

Sign in to the mobile app

This topic provides information about the Asset managementAsset management mobile workspace. This workspace lets users

view and create maintenance requests and work orders. Users can also view the assigned work order jobs in a

calendar or list view. Assets and functional locations can also be viewed and searched for.

Asset Management is an advanced module for managing assets and work order jobs in Dynamics 365 Supply

Chain Management. The Asset managementAsset management mobile workspace lets users quickly view assigned work order

jobs on the mobile device of their choice. Users can also create and manage maintenance requests, update

lifecycle state, and view asset and functional location details by using their mobile device.

Specifically, the Asset managementAsset management mobile workspace lets users perform these tasks:

Create, view, and edit maintenance requests, take a photo or attach an existing image to the maintenance

request, change the maintenance request lifecycle state.

Create, view, and edit work orders, take a photo or attach an existing image to the work order, change the

work order lifecycle state, view work order jobs.

View assigned work order jobs in a calendar view.

Create, view, and edit work order job, update asset counters, view maintenance checklist, view and edit work

order job notes, view the tools required for the work order job.

View or search for a specific asset or functional location.

Before you can use the Asset managementAsset management mobile workspace, your admin must set up the required user and

worker accounts, and publish the workspace. For more information, see Set up the Asset management mobile

workspace.

Download and install the Dynamics 365 for Unified Operations mobile app:

For Android phones

For iPhones

1. Start the app on your mobile device.

2. Enter your Dynamics 365 URL.

3. The first time that you sign in, you're prompted for your user name and password. Enter your credentials.

4. After you sign in, the available workspaces for your company are shown. Note that if your system

administrator publishes a new workspace later, you'll have to refresh the list of mobile workspaces.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/asset-management/asset-management-mobile-workspace.md
https://go.microsoft.com/fwlink/?linkid=850662
https://go.microsoft.com/fwlink/?linkid=850663


View assigned work order jobs in calendar view

Create a work order job

1. On your mobile device, open the Asset managementAsset management workspace.

2. Select My work order jobs calendarMy work order jobs calendar .

3. Select the date you want to view work order jobs for. In the list, you'll see the asset ID and functional

location ID for each work order job.

4. Select a work order job in the list to see job details: Asset and functional location details as well as other

navigation links to view AttachmentsAttachments , ChecklistsChecklists , ToolsTools , Asset countersAsset counters , NotesNotes , JournalsJournals .

1. On your mobile device, open the Asset managementAsset management workspace.

2. Select All maintenance work ordersAll maintenance work orders .

3. Select the work order you want to create a new work order job for.



Add attachment to a work order job

4. Select the Add lineAdd line button.

5. Select the AssetAsset you want to create a work order job for.

6. Select Maintenance job typeMaintenance job type, Maintenance job type var iantMaintenance job type var iant and TradeTrade.

7. Select DoneDone.

1. On your mobile device, open the Asset managementAsset management workspace.

2. Select All maintenance work ordersAll maintenance work orders .

3. Select the work order > work order job you want to add an attachment to.

Alternatively, you can also select My work order jobs calendarMy work order jobs calendar  or My work order jobs listMy work order jobs list on the

home page to navigate to the Work order job detailsWork order job details  page.

4. Select AttachmentsAttachments  on the Work order job detailsWork order job details  page.

5. You'll see existing attachments on the work order job. Select Add attachmentAdd attachment.

6. Enter NameName and NotesNotes  for the attachment.

7. Select Choose imageChoose image to select a photo from the mobile gallery, or Take photoTake photo to take a photo.

8. Select DoneDone.



  View maintenance checklist on a work order job
1. On your mobile device, open the Asset managementAsset management workspace.

2. Select All maintenance work ordersAll maintenance work orders .

3. Select the work order > work order job you want to view checklists for.

Alternatively, you can also select My work order jobs calendarMy work order jobs calendar  or My work order jobs listMy work order jobs list on the

home page to navigate to the work order job detailswork order job details  page.

4. Select ChecklistsChecklists  on the Work order job detailsWork order job details  page.

5. You'll see a list of checklist lines related to the work order job. Select a checklist line to view InstructionsInstructions

and add NotesNotes .

6. Select the back button (<<) to return to the previous page.



View and update asset counters on a work order job
1. On your mobile device, open the Asset managementAsset management workspace.

2. Select All maintenance work ordersAll maintenance work orders .

3. Select the work order > work order job you want to view asset counters for.

Alternatively, you can also select My work order jobs calendarMy work order jobs calendar  or My work order jobs listMy work order jobs list on the

home page to navigate to the work order job detailswork order job details  page.

4. Select Asset countersAsset counters  on the Work order job detailsWork order job details  page.

5. You see a list of asset counters related to the work order job. Select the pencil icon on an asset counter

line to update the counter value.

6. Enter a new counter value, and select DoneDone.



Register consumption on a work order job
1. On your mobile device, open the Asset managementAsset management workspace.

2. Select All maintenance work ordersAll maintenance work orders .

3. Select the work order > work order job you want to add consumption registrations for.

Alternatively, you can also select My work order jobs calendarMy work order jobs calendar  or My work order jobs listMy work order jobs list on the

home page to navigate to the work order job detailswork order job details  page.

4. Select JournalsJournals  on the Work order job detailsWork order job details  page.

5. Select Add hoursAdd hours  to create work hour registrations.

a. Select the Categor yCategor y  from the lookup.

b. In the HoursHours  field, enter the number of work hours spent on the work order job.

c. Select the appropriate L ine proper tyLine proper ty .

d. Select DoneDone.

6. Select Add itemsAdd items to create item registrations.

a. Select the Item numberItem number  from the lookup.

b. Select the S iteSite from the lookup.

c. Enter the QuantityQuantity  of items consumed.

d. Select DoneDone.

7. Select Add expenseAdd expense to create expense registrations.

a. Select the Categor yCategor y  from the lookup.

b. Enter the quantity for the expense registration.

c. Select the Sales currencySales currency  from the lookup.

d. Enter the Cost pr iceCost pr ice for the expense registration.



Update lifecycle state on a work order

e. Select DoneDone.

1. On your mobile device, open the Asset managementAsset management workspace.

2. Select All maintenance work ordersAll maintenance work orders .

3. Select the work order you want to update lifecycle state for.

4. Select the Update stateUpdate state button at the bottom of the screen.

5. Select a new lifecycle state from the list.

6. Select DoneDone.



Create a maintenance request
1. On your mobile device, open the Asset managementAsset management workspace.

2. Select All maintenance requestsAll maintenance requests .

3. Select ActionsActions  at the bottom of the screen, and select Create maintenance requestCreate maintenance request.

4. If number sequence is enabled for maintenance requests in Asset managementAsset management, the MaintenanceMaintenance

requestrequest field is hidden because it is automatically filled out. If the Maintenance requestMaintenance request field is visible,

enter a maintenance request ID.

5. Select a Maintenance request typeMaintenance request type.

6. Enter a Descr iptionDescr iption for the maintenance request.

7. Select the AssetAsset you want to create the request for.

8. Select the Ser vice levelSer vice level  for the maintenance request.

9. Select DoneDone.



Add attachment to a maintenance request
1. On your mobile device, open the Asset managementAsset management workspace.

2. Select All maintenance requestsAll maintenance requests .

3. Select the maintenance request you want to add an attachment to.

4. Select AttachmentsAttachments  at the bottom of the screen.

5. Select Add attachmentsAdd attachments .

6. Enter NameName and NotesNotes  for the attachment.

7. Select Choose imageChoose image to select a photo from the mobile gallery or Take photoTake photo to take a photo.

8. Select DoneDone.



NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Overview

Prerequisites
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One of the following products must be
deployed in your organization:

System administrator If you don't already have a Finance and
Operations app deployed in your
organization, see Deploy a demo
environment. If you don't already have
Human Resources deployed in your
organization, the system administrator
can access a trial version from the
Human Resources webpage.

The Company director yCompany director y  mobile
workspace must be published.

System administrator See Publish a mobile workspace.

Download and install the mobile app

Sign in to the mobile app

This topic provides information about the Company director yCompany director y  mobile workspace. This workspace lets users

view and contact other employees in their organization.

This mobile workspace can be used with the Finance and Operations mobile app.

The Company director yCompany director y  mobile workspace lets users perform these tasks:

View a list of employees in the organization.

Search for employees in the organization.

View contact information for employees.

Contact employees from the profile information.

Before you can use this mobile workspace, the following prerequisites must be met.

A Finance and Operations app

Microsoft Dynamics 365
Human Resources

Download and install the Finance and Operations mobile app:

For Android phones

For iPhones

1. Start the app on your mobile device.

2. Enter your Microsoft Dynamics 365 URL.

3. The first time that you sign in, you're prompted for your user name and password. Enter your credentials.

4. After you sign in, the available workspaces for your company are shown. Note that if your system

administrator publishes a new workspace later, you will have to refresh the list of mobile workspaces.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/mobile-apps/company-directory-mobile-workspace.md
https://dynamics.microsoft.com/human-resources/overview/
https://go.microsoft.com/fwlink/?linkid=850662
https://go.microsoft.com/fwlink/?linkid=850663


View the company directory by using the mobile workspace

Search the company directory by using the mobile workspace

NOTENOTE

1. In the mobile app, select the Company director yCompany director y  workspace. A list of employees is shown.

2. Select an employee. The Employee profileEmployee profile page appears. The information on this page includes the

employee's first name, last name, title, and department.

1. In the mobile app, select the Company director yCompany director y  workspace.

2. In the SearchSearch field, enter an employee's first name, last name, title, or department to start the search.

3. Select an employee. The Employee profileEmployee profile page appears. The information on this page includes the

employee's first name, last name, title, and department.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/mobile-apps/media/pull-to-refresh-list-of-workspaces.png
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Cost controlling mobile workspace
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Overview

Data securityData security

Actions, views, and linksActions, views, and links

This topic provides information about the Cost controllingCost controlling mobile workspace. This workspace lets cost center

managers view information about cost center performance anytime and anywhere.

This mobile workspace is intended to be used with the Finance and Operations mobile app.

The Cost controllingCost controlling mobile workspace provides an instant view of the current performance of cost centers by

comparing actual costs against the budgeted costs. You can drill down to the status of individual cost elements.

For example, an employee receives an invitation to an international conference, but the organization must cover

all the travel expenses. The employee asks their manager whether they can attend the conference. The manager

opens the Cost controllingCost controlling mobile workspace on their mobile device to see whether there is budget for the

employee to attend the conference.

The data in the Cost controllingCost controlling mobile workspace is secured through user credentials. Cost center managers

are allowed to see data only for their own cost center. The access-level security is managed in the CostCost

accountingaccounting module.

Cost accountants define the configuration of the Cost controllingCost controlling mobile workspace in the Cost accountingCost accounting

module. After the workspace is published to the mobile app, it's available in the app. Therefore, all cost center

managers in the organization can view data in the same format.

The Cost controllingCost controlling mobile workspace provides the following actions, views, and links:

Actions:Actions:

NOTENOTE

Use Select configurationSelect configuration to select a layout.

Use Select cost objectSelect cost object to select the cost centers to filter data on.

The cost centers that appear in the list depend on the access that is granted in the Cost accountingCost accounting

module.

Views:Views: Based on the actions that are selected and the configuration in the Cost accountingCost accounting module,

you can view the following information on the cards:

Actual vs budget (current period)

Actual vs revised budget (current period)

Actual vs budget (previous period)

Actual vs revised budget (previous period)

Actual vs budget (year to date)

Actual vs revised budget (year to date)

The following amounts are shown on every card: Actual, Budget, Variance, and Variance %.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/cost-accounting/cost-controlling-mobile-workspace.md


Prerequisites

Prerequisites if you use Microsoft Dynamics 365 FinancePrerequisites if you use Microsoft Dynamics 365 Finance

Prerequisites if you use version 1611 with Platform update 3 or laterPrerequisites if you use version 1611 with Platform update 3 or later
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Links:L inks:

Details for current period

Details for previous period

Details for year to date

When you select a link, a card is shown for each cost element. The following amounts are shown on

every card: Actual, Budget, Budget variance, Budget variance %, Revised budget, Revised budget variance,

and Revised budget variance %.

The prerequisites differ, based on the version of Microsoft Dynamics 365 that has been deployed for your

organization.

If Finance has been deployed for your organization, the system administrator must publish the CostCost

controllingcontrolling mobile workspace. For instructions, see Publish a mobile workspace.

If version 1611 with Platform update 3 or later has been deployed for your organization, the system

administrator must complete the following prerequisites.

file:///T:/eiye/ac1a/dynamics365/finance/cost-accounting/media/cost-controlling.png
file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/publish-mobile-workspace.html


Implement KB 4013633. System administrator KB 4013633 is an X++ update or
metadata hotfix that contains the
Cost controllingCost controlling mobile workspace.
To implement KB 4013633, your
system administrator must follow
these steps.

Publish the Cost controllingCost controlling mobile
workspace.

System administrator See Publish a mobile workspace.

P REREQ UISIT EP REREQ UISIT E RO L ERO L E DESC RIP T IO NDESC RIP T IO N

Download and install the mobile app

Sign in to the mobile app

View the performance of your cost center by using the Cost
controlling mobile workspace

1. Download the metadata hotfix
from Microsoft Dynamics
Lifecycle Services (LCS).

2. Install the metadata hotfix.

3. Create a deployable package
that contains the SCMMobileSCMMobile
model, and then upload the
deployable package to LCS.

4. Apply the deployable package.

Download and install the Finance and Operations mobile app:

For Android phones

For iPhones

1. Start the app on your mobile device.

2. Enter your Dynamics 365 URL.

3. The first time that you sign in, you're prompted for your user name and password. Enter your credentials.

4. After you sign in, the available workspaces for your company are shown. Note that if your system

administrator publishes a new workspace later, you will have to refresh the list of mobile workspaces.

1. On your mobile device, select the Cost controllingCost controlling workspace.

file:///T:/eiye/ac1a/dynamics365/dev-itpro/migration-upgrade/download-hotfix-lcs.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/migration-upgrade/install-metadata-hotfix-package.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/create-apply-deployable-package.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/apply-deployable-package-system.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/publish-mobile-workspace.html
https://go.microsoft.com/fwlink/?linkid=850662
https://go.microsoft.com/fwlink/?linkid=850663
file:///T:/eiye/ac1a/dynamics365/finance/cost-accounting/media/pull-to-refresh-list-of-workspaces.png


NOTENOTE

2. Select Cost object controllingCost object controlling.

3. Select ActionsActions .

4. Select Select configurationSelect configuration to select a cost controlling layout.

5. Select DoneDone.

6. Select ActionsActions .

7. Select Select cost objectSelect cost object to select the cost centers that you've been granted access to.

8. Select DoneDone.

9. View the overall performance of your cost center.

10. Select the Details for current per iodDetails for current per iod link.

11. View the performance of individual cost elements.

12. You can also search for specific cost elements.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Overview

Prerequisites

Prerequisites if you use Supply Chain ManagementPrerequisites if you use Supply Chain Management

Prerequisites if you use Platform update 3 or laterPrerequisites if you use Platform update 3 or later

This topic provides information about the Inventor y on-handInventor y on-hand mobile workspace. This workspace helps you

gain insights into reserved and available inventory anytime and anywhere.

This mobile workspace is intended to be used with the Finance and Operations mobile app.

Typically, companies have multiple shipments and multiple receipts of inventory every day. These movements

constantly change the on-hand inventory status. The Inventor y on-handInventor y on-hand mobile workspace lets you see the

cross-company on-hand inventory status, so that you can gain the latest insights into inventory data on the

mobile device of your choice. Regardless of whether you work in the warehouse, purchasing, sales,

manufacturing, or management, or have other roles, you can access on-hand inventory data anytime and

anywhere.

The mobile workspace provides an instant view of the on-hand status across facilities. It lets you view on-hand

inventory across facilities, current material reservations, and unreserved on-hand inventory. You can also enter

item numbers to query on-hand inventory, and can do a filtered search for on-hand products or variants.

Specifically, the mobile workspace provides these features:

You can search by product number or product name to find products to view the on-hand inventory

status for.

For the selected products, you can view the following information:

On-hand inventory per site

On-hand inventory per warehouse

On-hand inventory per location

On-hand inventory per batch (for batch-controlled products)

On-hand inventory per inventory status

Product on-hand inventory is shown in the following ways:

By physical inventory (This view represents the total amount.)

By physical reserved (This view represents the reserved amount.)

By available physical (This view represents available amount that has no reservations.)

The prerequisites differ, based on the version of Supply Chain Management that has been deployed for your

organization.

If Supply Chain Management has been deployed for your organization, the system administrator must publish

the Inventor y on-handInventor y on-hand mobile workspace. For instructions, see Publish a mobile workspace.

If Platform update 3 or later has been deployed for your organization, the system administrator must complete

the following prerequisites.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/inventory-on-hand-mobile-workspace.md
file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/publish-mobile-workspace.html
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Implement KB 4013633. System administrator KB 4013633 is an X++ update or
metadata hotfix that contains the
Inventor y on-handInventor y on-hand mobile
workspace. To implement KB 4013633,
your system administrator must follow
these steps.

Publish the Inventor y on-handInventor y on-hand
mobile workspace.

System administrator See Publish a mobile workspace.

Download and install the mobile app

Sign in to the mobile app

View the on-hand inventory for a product by using the Inventory on-
hand mobile workspace

1. Download the metadata hotfix
from Microsoft Dynamics
Lifecycle Services (LCS).

2. Install the metadata hotfix.

3. Create a deployable package
that contains the SCMMobileSCMMobile
model, and then upload the
deployable package to LCS.

4. Apply the deployable package.

Download and install the Finance and Operations mobile app:

For Android phones

For iPhones

1. Start the app on your mobile device.

2. Enter your Dynamics 365 URL.

3. The first time that you sign in, you're prompted for your user name and password. Enter your credentials.

4. After you sign in, the available workspaces for your company are shown. Note that if your system

administrator publishes a new workspace later, you will have to refresh the list of mobile workspaces.

file:///T:/eiye/ac1a/dynamics365/dev-itpro/migration-upgrade/download-hotfix-lcs.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/migration-upgrade/install-metadata-hotfix-package.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/create-apply-deployable-package.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/apply-deployable-package-system.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/publish-mobile-workspace.html
https://go.microsoft.com/fwlink/?linkid=850662
https://go.microsoft.com/fwlink/?linkid=850663
file:///T:/eiye/ac1a/dynamics365/supply-chain/inventory/media/pull-to-refresh-list-of-workspaces.png


NOTENOTE

1. On your mobile device, select the Inventor y on-handInventor y on-hand workspace.

2. Select Check on-hand for an itemCheck on-hand for an item. You see a list of the products that are loaded into your app for

offline use. By default, 50 items are loaded, but a developer can change this number. For more

information, developers should see Mobile platform.

3. If your item isn't in the list, select Search moreSearch more. Search by product number, or switch to a search by

product name.

4. Select a product. If the item has an image, the image is shown.

5. Select one of the following options to view the status of on-hand inventory:

View on-hand per site

View on-hand per warehouse

View on-hand per location

View on-hand per batch (for batch-controlled products)

View on-hand per inventory status

Product on-hand inventory is shown in the following ways:

By physical inventory (This view represents the total amount.)

By physical reserved (This view represents the reserved amount.)

By available physical (This view represents the available amount that has no reservations.)

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/platform/mobile-platform-home-page.html
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Overview

Prerequisites
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Microsoft Dynamics 365 Finance must
be deployed in your organization.

System administrator See Deploy a demo environment.

The Invoice approvalsInvoice approvals  mobile
workspace must be published.

System administrator See Publish a mobile workspace.

Download and install the mobile app

Sign in to the mobile app

This topic provides information about the Invoice approvalsInvoice approvals  mobile workspace. This workspace provides a list

of invoices that have been assigned to you through the vendor invoice header workflow process.

This mobile workspace is intended to be used with the Finance and Operations mobile app.

The Invoice approvalsInvoice approvals  mobile workspace lets Accounts payable clerks and managers view invoices that have

been assigned to them as part of the vendor invoice header workflow process. You can view the invoice

information, and even the line and distribution details, to help you make informed approval decisions. From the

workspace, you can take action to move the invoice through the workflow process.

Before you can use this mobile workspace, the following prerequisites must be met.

Download and install the Finance and Operations mobile app:

For Android phones

For iPhones

1. Start the app on your mobile device.

2. Enter your Microsoft Dynamics 365 URL.

3. The first time that you sign in, you're prompted for your user name and password. Enter your credentials.

4. After you sign in, the available workspaces for your company are shown. Note that if your system

administrator publishes a new workspace later, you will have to refresh the list of mobile workspaces.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/mobile-apps/invoice-approval-mobile-workspace.md
https://go.microsoft.com/fwlink/?linkid=850662
https://go.microsoft.com/fwlink/?linkid=850663


Approve invoices by using the Invoice approvals mobile workspace

NOTENOTE

1. On your mobile device, select the Invoice approvalsInvoice approvals  workspace.

2. Select the invoice that has been assigned to you by the vendor invoice header workflow process.

3. On the Invoice detailsInvoice details  page, review the invoice header information, such as the vendor and date

information.

4. Select a line on the invoice to view more detailed information about it in the Invoice line detailsInvoice line details  view.

5. In the Invoice line detailsInvoice line details  view, select Distr ibutionsDistr ibutions  to show the line distributions. Here, you can view the

accounting for the invoice line. The information that is shown includes the financial dimensions and the main

account.

6. On the Invoice detailsInvoice details  page, select Distr ibutionsDistr ibutions  to show all distributions. Here, you can view the

accounting for the whole invoice. The information that is shown includes the financial dimensions and the

main accounts.

7. Select AttachmentsAttachments  to view any notes or files that are attached to the invoice.

8. On the Invoice detailsInvoice details  page, select the appropriate workflow action to complete your review process.

9. Select DoneDone.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/mobile-apps/media/pull-to-refresh-list-of-workspaces.png
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Overview

Prerequisites
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One of the following products must be
deployed in your organization:

System administrator If you don't already have a Finance and
Operations app deployed in your
organization, see Deploy a demo
environment. If you don't already have
Human Resources deployed in your
organization, the system administrator
can access a trial version from the
Human Resources webpage.

The My teamMy team mobile workspace must
be published.

System administrator See Publish a mobile workspace.

Download and install the mobile app

Sign in to the mobile app

This topic provides information about the My teamMy team mobile workspace. This workspace lets managers view their

direct reports and extended staff. They can also send praise to individuals in their reporting chain.

This mobile workspace is intended to be used with the Finance and Operations mobile app.

The My teamMy team mobile workspace lets managers perform these tasks:

View a list of the manager’s direct reports.

View a list of the manager’s extended reporting team.

View detailed information for each team member, such as birth date, seniority date, years of service, and

compensation and performance information.

Send praise to any individual in the manager’s extended reporting team.

Before you can use this mobile workspace, the following prerequisites must be met.

A Finance and Operations app

Microsoft Dynamics 365
Human Resources

Download and install the Finance and Operations mobile app:

For Android phones

For iPhones

1. Start the app on your mobile device.

2. Enter your Microsoft Dynamics 365 URL.

3. The first time that you sign in, you're prompted for your user name and password. Enter your credentials.

4. After you sign in, the available workspaces for your company are shown. Note that if your system

administrator publishes a new workspace later, you will have to refresh the list of mobile workspaces.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/mobile-apps/manager-self-service-mobile-workspace.md
https://dynamics.microsoft.com/human-resources/overview/
https://go.microsoft.com/fwlink/?linkid=850662
https://go.microsoft.com/fwlink/?linkid=850663


View team members by using the My team mobile workspace

View extended team members by using the My team mobile
workspace

Send praise about team members by using the My team mobile
workspace

NOTENOTE

1. In the mobile app, select the My teamMy team workspace. A list of team members is shown. The list also shows each

team member's title, and any direct reports that the member has.

2. Select a team member. The Team member summar yTeam member summar y  page appears. The information on this page includes

the team member's birth date, seniority date, years of service, years in the current position, and

compensation information.

1. In the mobile app, select the My teamMy team workspace. A list of team members is shown. The list also shows each

team member's title, and any direct reports that the member has.

2. Select the Direct repor tsDirect repor ts  link. A list of your extended team is shown.

3. Select a team member. The Team member summar yTeam member summar y  page appears. The information on this page includes

the team member's birth date, seniority date, years of service, years in the current position, and

compensation information.

1. In the mobile app, select the My teamMy team workspace. A list of team members is shown. The list also shows each

team member's title, and any direct reports that the member has.

2. Select a team member. The Team member summar yTeam member summar y  page appears.

3. Select Send praiseSend praise.

4. Enter the text of the praise that you want to send.

5. Select DoneDone.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/mobile-apps/media/pull-to-refresh-list-of-workspaces.png
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Prerequisites

Prerequisites if you use Supply Chain ManagementPrerequisites if you use Supply Chain Management

Prerequisites if you use Microsoft Dynamics 365 for Operations version 1611 with Platform update 3 or laterPrerequisites if you use Microsoft Dynamics 365 for Operations version 1611 with Platform update 3 or later
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Implement KB 4017918. System administrator KB 4017918 is an X++ update or
metadata hotfix that contains the
Purchase order approvalPurchase order approval mobile
workspace. To implement KB 4017918,
your system administrator must follow
these steps.

Publish the Purchase orderPurchase order
approvalapproval mobile workspace.

System administrator See Publish a mobile workspace.

This topic provides information about the Purchase order approvalPurchase order approval  mobile workspace. This workspace lets

you view purchase orders and respond to them through actions. For example, you can approve or reject a

purchase order.

Purchase orders that requires approval go through an approval workflow. The workflow can include various

steps that require that one or more people take action. For example, a person might have to complete a task or

approve the purchase order.

The Purchase order approvalPurchase order approval  mobile workspace lets you easily view and respond to purchase orders from

your mobile device. This workspace also lets you take the same workflow actions that you can take from the

web client.

The prerequisites vary, depending on the version of Supply Chain Management that has been deployed for your

organization.

If Supply Chain Management has been deployed for your organization, the system administrator must publish

the Purchase order approvalPurchase order approval  mobile workspace. For instructions, see Publish a mobile workspace.

If Microsoft Dynamics 365 for Operations version 1611 with Platform update 3 or later has been deployed for

your organization, the system administrator must complete the following prerequisites.

1. Download the metadata hotfix
from Microsoft Dynamics
Lifecycle Services (LCS).

2. Install the metadata hotfix.

3. Create a deployable package
that contains the SCMMobileSCMMobile
model, and then upload the
deployable package to LCS.

4. Apply the deployable package.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/purchase-order-mobile-workspace.md
file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/publish-mobile-workspace.html
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file:///T:/eiye/ac1a/dynamics365/dev-itpro/migration-upgrade/install-metadata-hotfix-package.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/create-apply-deployable-package.html
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Download and install the mobile app

Sign in to the mobile app

View orders that are assigned to you

Complete an action on the purchase order

Download and install the Finance and Operations mobile app:

For Android phones

For iPhones

1. Start the app on your mobile device.

2. Enter your Microsoft Dynamics 365 URL.

3. The first time that you sign in, you're prompted for your user name and password. Enter your credentials.

4. After you sign in, the available workspaces for your company are shown. Note that if your system

administrator publishes a new workspace later, you will have to refresh the list of mobile workspaces.

1. On your mobile device, select the Purchase order approvalPurchase order approval  workspace.

2. Select Orders assigned to meOrders assigned to me to view all the purchase orders for which you've been asked to take action in

the purchase order approval workflow.

3. Select an order. On the Order detailsOrder details  page, you will see the order header information and lines. You can also

find guidelines from the workflow task.

4. Select Accounting distr ibutionsAccounting distr ibutions  to open the Header accounting distr ibutionsHeader accounting distr ibutions  page.

5. Return to the Order detailsOrder details  page, and select a line. From the order line details, you can also explore the line-

specific accounting distributions.

After you've viewed the purchase order that is assigned to you and read the workflow instructions, you should

be ready to take action.

1. On your mobile device, select the Purchase order approvalPurchase order approval  workspace.

2. Select Orders assigned to meOrders assigned to me to view all the purchase orders for which you've been asked to take

https://go.microsoft.com/fwlink/?linkid=850662
https://go.microsoft.com/fwlink/?linkid=850663


NOTENOTE

TA SK  A C T IO NTA SK  A C T IO N A P P RO VA L  A C T IO NA P P RO VA L  A C T IO N

Complete Approve

Return Reject

Request change Request change

Delegate Delegate

action in the purchase order approval workflow.

3. Select an order, and view the details page.

4. Select ActionsActions  to show the available actions. The actions that are available depend on the task that has

been assigned to you.

5. Select the appropriate action.

6. On the Complete taskComplete task page, enter a comment. Note that if you select the DelegateDelegate action, you must

select a user to delegate the task to.

7. Select DoneDone. After you refresh your workspace, the purchase order will no longer be in your list.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Overview

View all sales ordersView all sales orders

View orders for a customerView orders for a customer

This topic provides information about the Sales ordersSales orders  mobile workspace. This workspace helps you stay up to

date about your sales orders anywhere and anytime.

This mobile workspace is intended to be used with the Finance and Operations mobile app.

The Sales ordersSales orders  mobile workspace lets you view detailed information about each sales order. This information

includes the status of the order, contact information for the customer, and contact information for the order

taker. The Sales ordersSales orders  mobile workspace provides an instant view of sales orders. You can view all sales

orders, view sales orders by customer, or view information about a specific sales order.

The mobile workspace provides two views to help you analyze sale orders in depth.

This view lists all sales orders.

Use one of the following filters to select the sales orders to view:

Search by sales order

Search by customer account

Search by customer name

Search by status

Search by release status

Search by created date and time

After you select sales orders, you can view the details of specific orders. Specifically, you can view the

following information:

Customer name and address information

Various dates for the sales order, such as the requested ship date and the confirmed ship date

Contact information for the order taker

Customer contact information

Order lines

Shipments that show how and when a sales order was shipped

This view lists sales orders by customer.

Use one of the following filters to view orders for a customer:

Search by name

Search by account

After you select a customer, you can view the following information:

Customer name and group

Customer contact information

Customer sales orders and details about those sales orders:

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/sales-orders-mobile-workspace.md
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Implement KB 4013633. System administrator KB 4013633 is an X++ update or
metadata hotfix that contains the
Sales ordersSales orders  mobile workspace. To
implement KB 4013633, your system
administrator must follow these steps.

Publish the Sales ordersSales orders  mobile
workspace.

System administrator See Publish a mobile workspace.

Download and install the mobile app

Sign in to the mobile app

Customer name and address information

Various sales order dates

Contact information for the order taker

Customer contact information

Order lines

Shipments that show how and when a sales order was shipped

The prerequisites differ, based on the version of Microsoft Dynamics 365 that has been deployed for your

organization.

If Supply Chain Management has been deployed for your organization, the system administrator must publish

the Sales ordersSales orders  mobile workspace. For instructions, see Publish a mobile workspace.

If Dynamics 365 for Operations version 1611 with platform update 3 or later has been deployed for your

organization, the system administrator must complete the following prerequisites.

1. Download the metadata hotfix
from Microsoft Dynamics
Lifecycle Services (LCS).

2. Install the metadata hotfix.

3. Create a deployable package
that contains the SCMMobileSCMMobile
model, and then upload the
deployable package to LCS.

4. Apply the deployable package.

Download and install the Finance and Operations mobile app:

For Android phones

For iPhones

1. Start the app on your mobile device.

2. Enter your Dynamics 365 URL.

3. The first time that you sign in, you're prompted for your user name and password. Enter your credentials.

4. After you sign in, the available workspaces for your company is shown. Note that if your system

administrator publishes a new workspace later, you will have to refresh the list of mobile workspaces.

file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/publish-mobile-workspace.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/migration-upgrade/download-hotfix-lcs.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/migration-upgrade/install-metadata-hotfix-package.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/create-apply-deployable-package.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/apply-deployable-package-system.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/publish-mobile-workspace.html
https://go.microsoft.com/fwlink/?linkid=850662
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View information about sales orders for a customer by using the Sales
order mobile workspace

NOTENOTE

1. On your mobile device, select the Sales ordersSales orders  workspace.

2. Select View orders for a customerView orders for a customer .

3. Use account or customer name information to find the customer.

4. Select the customer.

5. Select Contact informationContact information or Sales ordersSales orders . If you select Sales ordersSales orders , a list of sales orders for the

customer is shown.

6. Select Sales orderSales order . You can now view information about sales order lines, information about shipments,

customer contact information, and contact information for the order taker.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/supply-chain/sales-marketing/media/pull-to-refresh-list-of-workspaces.png
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Overview
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Prerequisites

This topic provides information about the Vendor collaborationVendor collaboration mobile workspace. This workspace helps your

vendors stay up to date about the purchase orders that have been sent to them for approval. They can also view

information about new and updated purchase orders and contacts.

This mobile workspace is intended to be used with the Finance and Operations mobile app.

The Vendor collaborationVendor collaboration mobile workspace keeps vendors informed about new purchase orders, so that

they can view purchase orders and then respond to them in the web client.

The mobile workspace should be used as a supplement to the vendor collaboration web interface, not a replacement for

it.

Your vendors can use the Vendor collaborationVendor collaboration mobile workspace to view new purchase orders that are sent

to them for approval. It shows purchase order information, such as products, quantities, and requested delivery

dates. Price information is also available, depending on the configuration of each vendor.

A user who signs in as a vendor will see which purchase orders have been responded to, and which purchase

orders are still awaiting customer action. For example, a purchase order might be awaiting customer action

because the vendor suggested another delivery date, but the customer hasn't yet agreed to that date. The

vendor will also see a list of purchase orders that have been confirmed but haven't yet been delivered.

To respond to a purchase order, the vendor must use the vendor collaboration web interface that is available in

the web client. There, the vendor can also get more information about the order, such as document attachments,

the delivery address per line, and charges that are associated with the vendor.

Vendors that have a special security role can see which contact persons are registered for a vendor account. The

same security role lets a vendor view the status of any user request that has been submitted.

The vendor collaboration web interface in the web client must be used to create new contacts and submit new

user requests.

The Vendor collaborationVendor collaboration mobile workspace lets a vendor perform these tasks:

View new purchase orders that are sent to the vendor.

View purchase orders that the vendor has responded to, and that are awaiting customer action.

View purchase orders that have been confirmed but haven't yet been fully received.

View contact person information that is registered for the vendor account. (This task requires an additional

security role.)

View information about a user request that was submitted by the vendor, and follow the status of the

request. (This task requires an additional security role.)

The prerequisites vary, depending on the version of Microsoft Dynamics 365 that has been deployed for your

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/vendor-collaboration-mobile-workspace.md
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KB 3216943 must be implemented if
you're using Platform update 3.

System administrator KB 3216943 is a binary update that is
required if you're using Platform
update 3. To implement this KB, the
system administrator must follow
these steps.

KB 4013633 must be implemented. System administrator KB 4013633 is an X++ update or
metadata hotfix that contains the
Inventor y on-handInventor y on-hand mobile
workspace. To implement KB 4013633,
your system administrator must follow
these steps.

The Vendor collaborationVendor collaboration mobile
workspace must be published.

System administrator See Publish a mobile workspace.

The vendor user must have access to
the vendor collaboration web interface
in the web client and must set up a
vendor collaboration user.

Purchasing professionals and the
system administrator

Follow the steps in the following topics
to set up and work with the vendor
collaboration web interface.

organization.

If Supply Chain Management has been deployed for your organization, the system administrator must publish

the Vendor collaborationVendor collaboration mobile workspace. For instructions, see Publish a mobile workspace.

If Microsoft Dynamics 365 for Operations version 1611 with Platform update 3 or later has been deployed for

your organization, the system administrator must complete the following prerequisites.

1. Download KB 3216943 from
Microsoft Dynamics Lifecycle
Services (LCS).

2. Install the binary update, which
is delivered as a deployable
package. For information about
how to apply a deployable
package, see Apply a
deployable package.

1. Download the metadata hotfix
from LCS.

2. Install the metadata hotfix.

3. Create a deployable package
that contains the SCMMobileSCMMobile
model, and then upload the
deployable package to LCS.

4. Apply the deployable package.

Use vendor collaboration to
work with external vendors

Manage vendor collaboration
users

Set up and maintain vendor
collaboration

Use vendor collaboration to
work with customers in Supply
Chain Managements

file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/publish-mobile-workspace.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/apply-deployable-package-system.html
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file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/create-apply-deployable-package.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/apply-deployable-package-system.html
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Download and install the mobile app

Sign in to the mobile app

Use the Vendor collaboration mobile workspace

Download and install the Finance and Operations mobile app:

For Android phones

For iPhones

1. Start the app on your mobile device.

2. Enter your Microsoft Dynamics 365 URL.

3. The first time that you sign in, you’re prompted for your user name and password. Enter your credentials.

4. After you sign in, the available workspaces for your company are shown. Note that if your system

administrator publishes a new workspace later, you will have to refresh the list of mobile workspaces.

When you select the Vendor collaborationVendor collaboration workspace, you’ll see the following options.

https://go.microsoft.com/fwlink/?linkid=850662
https://go.microsoft.com/fwlink/?linkid=850663
file:///T:/eiye/ac1a/dynamics365/supply-chain/procurement/media/pull-to-refresh-list-of-workspaces.png


ContactsContacts

User requestsUser requests

Purchase orders ready for reviewPurchase orders ready for review

The Vendor collaborationVendor collaboration workspace includes the following pages.

The ContactsContacts  page lets you see all the contacts that have been set up for the vendor account. It shows the

contact person's name, primary email address, and user alias, if the contact person has an alias. This page also

shows whether the contact person's user account is active. When you select a contact, you see contact details,

such as the legal entities that the person is a contact for. You also see contact information, such as a telephone

number or an alternative email address.

The User requestsUser requests  page lets you see all the user requests that you've submitted via the vendor collaboration

web interface. You can also follow the status of those requests. When you select a user request, you can see what

was requested, add or inactivate a user, change security, and see which security roles were requested for the

user.

The Purchase orders ready for reviewPurchase orders ready for review  page lets you see all the purchase orders that the customer has sent,

but that haven't yet been responded to. You can view selected information about the order, such as which

products were requested and when those products should be delivered. Price information is also available,

depending on the configuration of the vendor.

You can also see whether the purchase order has notes or attachments. However, to open notes and

attachments, you must use vendor collaboration web interface in the web client. Select Purchase order linePurchase order line to

see all the lines together with their details. For each line, an indicator will show whether there are notes or



Awaiting customer actionAwaiting customer action

Open confirmed ordersOpen confirmed orders

NOTENOTE

attachments, or whether the delivery address differs from the delivery address that is shown on the header.

To respond to the purchase order, you must use the vendor collaboration web interface in the web client.

The Awaiting customer actionAwaiting customer action page lets you find purchase orders that you or another person in your

company who has access to vendor collaboration has responded to. The purchase orders are visible in this list

only if the customer must take one of the following actions on the purchase order :

If the purchase order was rejected, the customer must either update or cancel the original order, and then

send it again. When the purchase order is sent again, it no longer appears on the Awaiting customerAwaiting customer

actionaction page.

If the purchase order was accepted with changes, the customer must either update the original order and

then send it again for review, or update the order per the requested changes and then confirm it immediately.

In both cases, the purchase order no longer appears on the Awaiting customer actionAwaiting customer action page.

If the purchase order was accepted but still appears on the Awaiting customer actionAwaiting customer action page, the purchase

order wasn't automatically confirmed when it was accepted. It's now waiting for a purchasing agent to

change the order status to ConfirmedConfirmed. Typically, a purchase order is considered an agreement between the

customer and the vendor as soon as the vendor accepts the order. Therefore, the update to ConfirmedConfirmed

status is usually just a formality.

When you select a purchase order, additional details appear about the response. You can see the line details and

response for every line. The line status shows which of the following responses has been given:

Accepted

Rejected

Accepted with changes

Substituted/Substitute

Split into schedule/Schedule line

Note that the Deliver ingDeliver ing field is set to either YesYes  or NoNo to indicate whether the lines will be delivered. A line

might not be delivered because for the following reasons:

The line was rejected.

A substitution was made, and the original line isn't expected to be delivered as requested in the received

order.

The line was split into multiple schedule lines, and the original line isn't expected to be delivered as requested

in the received order.

Any changes that have been made to the order line response are shown. However, uploaded notes and

attachments aren't shown. To view notes and attachments, you must use the vendor collaboration web interface

in the web client.

When the purchase order is confirmed by the customer (that is, the status of the purchase order is changed to

ConfirmedConfirmed), it appears in the open confirmed order. It will remain in the list until it's registered as received by

the customer.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Publish a mobile workspace

NOTENOTE

This topic describes the steps that system administrators must follow to publish a mobile workspace. A mobile

workspace must be published so that users can access it in the mobile app.

1. In your browser, start your web client.

2. Click SettingsSettings  > Mobile appMobile app.

3. Select the mobile workspace to publish.

4. Click PublishPublish .

After a new workspace is published, users must pull to refresh the list of mobile workspaces.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/mobile-apps/publish-mobile-workspace.md
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Excel Data Connector add-in

Dynamics AX 2012 architecture vs. Finance and Operations architectureDynamics AX 2012 architecture vs. Finance and Operations architecture

Dynamics AX 2012Dynamics AX 2012

Applies to these Dynamics 365 appsApplies to these Dynamics 365 apps :

Commerce, Finance, Supply Chain Management

This topic reviews Microsoft Office integration concepts and features. The integration depends on several

technologies:

Working in Microsoft Azure

Working with Azure Active Directory (Azure AD)

Running a web client in multiple browsers

The Microsoft Office integration capabilities provide users with a productive environment that helps them get

the job done by using Office products.

Microsoft Excel can change and quickly analyze data. The Excel Data Connector app interacts with Excel

workbooks and OData services that are created for publicly exposed data entities. The Excel Data Connector

add-in enables Excel to become a seamless part of the user experience. The Excel Data Connector add-in is built

by using the Office Web add-ins framework. The add-in runs in a task pane. Office Web Add-ins are web

applications that run inside an embedded Internet Explorer browser window.

There are several differences between versions. For both, we built lightweight add-ins that run in Excel and use

services to connect to the application.

Excel > VSTO (.NET) Add-in > Windows Communication foundation (WCF) > Authentication through Active

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/office-integration/office-integration.md
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/office-integration/media/1_office.png


Finance and OperationsFinance and Operations

Office Add-in explainedOffice Add-in explained

N UM B ERN UM B ER N A M EN A M E DESC RIP T IO NDESC RIP T IO N

1 Add-in primary title The title of the add-in that is provided
to the Office Web Add-ins framework.

2 Add-in secondary title The title of the add-in that is provided
by the add-in.

3 Source name The label of the entity that provides
data for the selected data table. You
can hover over the label to see the
corresponding name.

4 Field name The label of the field that provides data
for the selected data table column. You
can hover over the label to see the
corresponding name and type.

5 Refresh button Refresh the data in the workbook.

6 Publish button Publish the data changes in the
workbook.

7 Design button Open the design-time experience.

Directory (AD) > AIF SOAP services on the AOS > AX Services and Tables > AX query engine > Database

Excel > Office Web Add-in (JS + HTML) > JavaScript OData API (Olingo) > Authentication through Azure Active

Directory (AAD) > AX OData services on the AOS > AX Entities > AX LINQ provider > AX Database

The Excel Data Connector app is located in a task pane on the right side of a workbook. 

The following table describes the parts of the add-in. The numbers correspond to the numbers in the preceding

screen shot.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/office-integration/media/2_office.png


8 Status bar The status bar provides brief
temporary information alerts.
Information that is appears in the
status bar also appears in the
MessagesMessages dialog box.

9 Options button Open the OptionsOptions dialog box.

10 Messages button Open the MessagesMessages dialog box, which
displays the information messages,
warnings, and errors that the program
provides to the user. A number
sometimes appears next to the
MessagesMessages button to provide a count
of the warnings or errors that the user
might be interested in.

11 Excel data table containing data The filter and sort controls in the
columns headers can be used on this
data. The filters must be removed
before data changes are published.

12 Office Web Add-ins menu The Office Web Add-ins menu button
provides several standard links. The
most important of the links is used to
reload the add-in. When the add-in is
reloaded, it updates all the data for the
workbook that is contained in tables
that are associated with the add-in.

N UM B ERN UM B ER N A M EN A M E DESC RIP T IO NDESC RIP T IO N

AuthenticationAuthentication

Lookups and drop-down listsLookups and drop-down lists

Adding and deleting recordsAdding and deleting records

Workbook Designer

OData sits on the same authentication stack as the server. The add-in uses OAuth to facilitate authentication.

When you click in a table cell, any lookup, enumeration drop-down list, or date picker that is associated with that

cell will be shown inside the add-in, underneath the source and field information. Any value that you select

inside the add-in is put into the currently selected table cell.

To add a record, either start typing in a row directly below a table, or use the Tab key to tab away from the last

cell of the last row in the table. To delete a record, select the row by clicking the row label (1, 2, 3, and so on), and

delete all the cells in that row. To publish the changes, click PublishPublish . The MessagesMessages  dialog box shows how

many records were added, edited, and deleted.

You can use the Workbook DesignerWorkbook Designer  page to design an editable custom export workbook that contains an

entity and a set of fields. To open the Workbook DesignerWorkbook Designer  (Expor tToExcelWorkbookDesignerExpor tToExcelWorkbookDesigner ) page, click

Common > Common > Office Integration > Excel workbook designerCommon > Common > Office Integration > Excel workbook designer . Before you can publish data

edits, all the key fields of the entity must be in the Excel table. Key fields have a key symbol next to them. To

successfully create or update a record, it must have all the mandatory fields in the Excel table. Mandatory fields

have an asterisk (*) next to them.



Document management

Document previewDocument preview

Frequently asked questions
Office LicensingOffice Licensing
What Microsoft 365 licenses are available?What Microsoft 365 licenses are available?

After purchasing a Microsoft 365 license, what needs to be done to set up SharePoint storage for attachments?After purchasing a Microsoft 365 license, what needs to be done to set up SharePoint storage for attachments?

To retrieve the resulting workbook, click Create workbookCreate workbook in the app bar.

Click View related formView related form to see the data that the entity exposes. This button is only enabled for entities that

have a FormRefFormRef property value.

Document management supports saving record attachments in Azure Blob storage and SharePoint Online.

Database storage is deprecated. Azure Blob storage is equivalent to storage in the database since documents

can only be accessed through the application and it provides the added benefit of providing storage that doesn't

negatively affect the performance of the database. Azure blob storage is the default and works immediately.

SharePoint storage will work immediately if you have an O365 license since we auto-discover the SharePoint

tenant e.g. a user on the TenantA.onmicrosoft.com O365/AAD tenant gets TenantA.sharepoint.com as the

SharePoint site. If document management has been turned off by the user, turn it on by clicking Options >Options >

General > MiscellaneousGeneral > Miscellaneous  and setting Document handling activeDocument handling active to YesYes .

On any page that has data, an AttachAttach button will be available in the upper-right corner.

The AttachmentsAttachments  page provides a view of the attachments (documents) that are associated with the record that

was selected on the previous page. You can add new attachments to the record by clicking the NewNew  button (++)

in the app bar. For the FileFile and ImageImage document types, you will be prompted to provide the associated file.

A preview for supported file types is provided on the PreviewPreview  FastTab. Basic document types, such as PNG

images and text files, are supported by default. Office document types, such as Microsoft Word, Excel, and

PowerPoint files, must use a production Office Web Apps Server, which might not be available in a OneBox

configuration.

There are lots of Microsoft 365 license options. You should select the license that makes sense for your

organization.

Open the Document Parameters form and ensure that the SharePoint server has been automatically discovered

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/office-integration/media/3_office.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/office-integration/media/4_office.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/office-integration/media/5_office.png
https://products.office.com/business/compare-office-365-for-business-plans


Additional resources

NOTENOTE

and set. Now open or create a Document Type, set the Document Type's location to "SharePoint" and select the

folder that the files should be stored in.

Office integration tutorial

Troubleshoot the Office integration

Application stack and server architecture

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-tools/application-stack-server-architecture
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Office integration tutorial
2/18/2021 • 27 minutes to read • Edit Online

Overview

Prerequisites

Key concepts

Applies to these Dynamics 365 appsApplies to these Dynamics 365 apps :

Commerce, Finance, Human Resources, Supply Chain Management

In this tutorial, you will use and build Office integration experiences that involve Excel, Word, Document

Management, and email.

In this tutorial, you will use and build Microsoft Office integration experiences that involve Microsoft Excel,

Microsoft Word, the Document Management subsystem, and email. You will see how Excel and Word use data

entities as an entry point into the system, how Excel can become a core part of the user experience, and how

Excel and Word can be used for ad-hoc lightweight reporting. You will also see how files can be stored and

shared by using the Document Management and email capabilities.

For this tutorial, you must access the environment by using Remote Desktop, and you must be provisioned as an

administrator on the instance. For more information, see Deploy and access development environments. If

you're running Internet Explorer on the virtual machine (VM), you must enable font and file downloads at

Internet OptionsInternet Options  > SecuritySecurity  > Custom LevelCustom Level . Microsoft Visual Studio 2015 runs on the VM, and it must run

as an administrator so that metadata and compilation files can be overwritten. To make sure that Visual Studio

runs as an administrator, search for the program, and pin it to the taskbar. Then right-click the shortcut on the

taskbar, right-click Visual Studio 2015Visual Studio 2015 , click Proper tiesProper ties  > AdvancedAdvanced, and select the Run as administratorRun as administrator

check box. Visual Studio will now run as an administrator via a single left click of the taskbar shortcut.

Entities and ODataEntities and OData – You will use the Microsoft Dynamics Excel Data Connector App (Excel App) to create,

read, update, and delete. The connector uses OData services that are created for any entity that is left in the

default state of "public" (DataEntity.PublicDataEntity.Public=YesYes ).

Apps for OfficeApps for Office – The Excel App is built by using the Apps for Office framework (which is also known as the

Office Web API). The Excel App is web-based, and therefore shares technology with the client and will run

inside both on-premises Excel instances and Microsoft Excel Online (Microsoft 365). The app runs inside Excel

in a task pane.

Microsoft Office 2016Microsoft Office 2016  – The Excel and Word Apps use advances in the Apps for Office framework that

were introduced in Office 2016. Therefore, Office 2016 is required in order to run the Excel and Word Apps.

AuthenticationAuthentication – The Excel and Word Apps run in an Internet Explorer window inside Excel and Word. Even

if the user is running the client in an InPrivate Browsing session in Internet Explorer, or in a different browser,

such as Chrome, Internet Explorer is still used to run the app inside Excel or Word. Authentication is

facilitated by OAuth, and the user can select accounts and sign in within the app. Internet Explorer will first

try to automatically sign the user in. Therefore, if you aren't signed in as the correct user, or if you have

trouble signing in, you might have to force a sign-out from the app by using the sign-out link on the user

menu in the lower-right corner of the app. After sign-out, right-click in the app, and try to sign in again.

Excel AppExcel App – In addition to facilitating refresh and publish data operations, the Excel App also provides

source and field information, lookups, filtering, error messaging, and a design experience for adding or

removing fields, table columns, or labels from entity data sources.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/office-integration/office-integration-tutorial.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-tools/access-instances


Setup
Load the Fleet data setLoad the Fleet data set

Static Export to Excel experiences
Static Export to ExcelStatic Export to Excel

Modify the static Export to Excel experienceModify the static Export to Excel experience

Generated Open in Excel experiences
Generated Open in ExcelGenerated Open in Excel

During this tutorial, we will mainly use forms, entities, and data in the Fleet Management model. Therefore, we

must first load the Fleet data set.

1. Navigate to Fleet ManagementFleet Management > SetupSetup > FleetFleet setupsetup.

2. Click CreateCreate.

Static Export to Excel provides a quick mechanism for getting data into grids on a page. The standard

mechanism for triggering Export to Excel is the Open inOpen in Microsoft OfficeMicrosoft Office menu. Static Export to Excel is also

available via a shortcut menu on the grid.

1. In Internet Explorer, navigate to Fleet ManagementFleet Management > CustomersCustomers  > CustomerCustomer .

2. Click Open inOpen in Microsoft OfficeMicrosoft Office > Expor t to ExcelExpor t to Excel  > CustomersCustomers .

3. Download and open the workbook that is generated. Note that the columns in the workbook match the

columns in the grid.

4. Select ("mark") the first two rows by clicking in the left edge of the row, below the "Select all" check mark.

5. Right-click the grid header to open the shortcut menu. Note that both Expor t all rowsExpor t all rows  and Expor t markedExpor t marked

rowsrows are available as commands.

6. Click Expor t marked rowsExpor t marked rows . Note that the columns in the workbook match the columns in the grid, and that

the rows that are exported match the rows that you marked.

You can suppress the static Export to Excel mechanism for a grid or change the label that appears on the OpenOpen

inin Microsoft OfficeMicrosoft Office menu.

1. Start Visual Studio 2015. Make sure that it's running as an administrator.

2. Click ViewView  > Application ExplorerApplication Explorer  (or press Ctrl+E, Ctrl+E).

3. Navigate to AOTAOT > User InterfaceUser Interface > FormsForms > FMCustomerFMCustomer .

4. Right-click FMCustomerFMCustomer , and then click Add to new projectAdd to new project.

5. In Solution Explorer, double-click the FMCustomerFMCustomer  form to open the designer view.

6. Select FMCustomerDesignTab(Tab)TabPageGrid(TabPage)MainGrid(Grid)FMCustomerDesignTab(Tab)TabPageGrid(TabPage)MainGrid(Grid) .

7. In the Proper tiesProper ties  window, find the Expor t LabelExpor t Label  property.

8. Set the Expor t LabelExpor t Label  property to Fleet CustomersFleet Customers .

9. Save the form. If you're asked whether you want to overwrite the existing form or save it as a new form, click

Over writeOver write.

10. Build the solution (press Ctrl+Shift+B).

11. In Internet Explorer, navigate to Fleet ManagementFleet Management > CustomersCustomers  > CustomerCustomer .

12. Click Open in Microsoft OfficeOpen in Microsoft Office. Note that the CustomersCustomers  option has changed to Fleet CustomersFleet Customers .

Generated Open in Excel options are automatically added to forms when the system finds data entities that have

the same root data source as the form. The workbook that is generated will contain a single table data source

where the data from that entity is loaded. The Open in Excel experiences are listed on the Open inOpen in MicrosoftMicrosoft

OfficeOffice menu. (When an entity has the same root data source as a form, it's added as an option in the Open inOpen in



Add and remove table columns from an existing table data source in the Excel AppAdd and remove table columns from an existing table data source in the Excel App

ExcelExcel  section of the Open in Microsoft OfficeOpen in Microsoft Office menu. This option is referred to as a “generated” option.)

1. In Internet Explorer, navigate to Fleet ManagementFleet Management > CustomersCustomers  > CustomerCustomer .

2. Click Open inOpen in Microsoft OfficeMicrosoft Office > Open in ExcelOpen in Excel  > Fleet Management Customers (unfiltered)Fleet Management Customers (unfiltered) .

3. Download and open the workbook that is generated. This workbook contains the Excel Data Connector App,

a binding to the Fleet Management CustomerFleet Management Customer  entity, and a pointer to the server that the workbook was

generated from.

4. Click Enable editingEnable editing to enable the Excel Data Connector App to load. Customer data is read from the OData

service on the server and added to the table.

5. In Internet Explorer, on the CustomerCustomer  page, click EditEdit (or press F2), and change the email address of one of

the customers.

6. In the Excel App, click RefreshRefresh. Note that the new email address is shown in Excel.

7. In Excel, change the email address of one of the customers.

8. In the Excel App, click PublishPublish .

9. In Internet Explorer, click RefreshRefresh in the upper right of the page (or press Shift+F5). Note that the new email

address is shown on the CustomerCustomer  page.

10. In Excel, click the SettingsSettings  (gear) button in the lower-right corner of the Excel App. You can use the dialog

box that appears to adjust the settings in the current workbook. Note that the Ser ver URLSer ver URL  value matches

the start of the URL that is shown in Internet Explorer. Also note that the data refresh and data publish

operations are listed.

11. Click CancelCancel  to close the SettingsSettings  dialog box.

12. Click the Message CenterMessage Center  (flag) button in the lower-right corner of the Excel App. The message center

dialog box that appears provides information about what is occurring in the Excel App.

The Excel App has a design experience that lets users add and edit bindings to entity data sources and labels. To

add and remove fields from an existing binding, you use the edit experience that is outlined in the following

steps.

1. Get a workbook that has an existing table data source:

a. In Internet Explorer, navigate to Fleet ManagementFleet Management > CustomersCustomers  > CustomerCustomer .

b. Click Open in Microsoft OfficeOpen in Microsoft Office > Open in ExcelOpen in Excel  > Fleet Management Customers (unfiltered)Fleet Management Customers (unfiltered) .

c. Download and open the workbook that is generated. This workbook contains the Excel Data

Connector App, a binding to the Fleet Management Customer entity, and a pointer to the server that

the workbook was generated from.

d. Click Enable editingEnable editing to enable the Excel Data Connector App to load. Customer data is read from the

OData service on the server and added to the table.

2. Open the data source for editing:

a. In Excel, in the Excel App, click DesignDesign. A list of table and field data sources appears.

b. Click the EditEdit (pencil) button next to the existing table data source. The data source details are shown.

3. Remove fields. In the SelectedSelected list, double-click a field. Alternatively, click a field, and then click RemoveRemove.

To select multiple fields, keep the Ctrl key held down while you click them. To select all fields, press Ctrl+A.

4. Add fields. In the AvailableAvailable list, double-click a field. Alternatively, click a field, and then click AddAdd. To

select multiple fields, keep the Ctrl key held down while you click them. To select all fields, press Ctrl+A.

5. Change the field order. In the SelectedSelected list, click a field, and then click UpUp or DownDown.

6. Change a field label. In the SelectedSelected list, click a field, and then click in the Column labelColumn label  field below the

list. You can change the label to either a static string or a label identifier that will be translated to the

active language (for example, @SYS129977@SYS129977 ).



Change an automatically generated Open in Excel experienceChange an automatically generated Open in Excel experience

Open in Excel OnlineOpen in Excel Online

Template Open in Excel experiences
Template Open in ExcelTemplate Open in Excel

7. Apply the changes that you made to data source fields:

a. Click UpdateUpdate to return to the data source list.

b. Click RefreshRefresh to make sure that any new fields are filled with data.

The automatically generated Open in Excel experiences that are created for entities have a single table binding.

The list of fields that are added to that table binding is defined by the AutoRepor tAutoRepor t field group if the table

binding contains fields. Otherwise, the key and mandatory fields for the entity are automatically added. The

order of fields in the AutoRepor tAutoRepor t group determines the order of fields in the table binding.

1. Start Visual Studio 2015. Make sure that it's running as an administrator.

2. Click ViewView  > Application ExplorerApplication Explorer  (or press Ctrl+E, Ctrl+E).

3. Navigate to AOTAOT > Data ModelData Model  > Data EntitiesData Entities  > FMCustomerEntityFMCustomerEntity .

4. Right-click FMCustomerEntityFMCustomerEntity , and then click Add to projectAdd to project.

5. Expand FMCustomerEntityFMCustomerEntity  > Field GroupsField Groups  > AutoRepor tAutoRepor t.

6. Reverse the order of the First nameFirst name and Last nameLast name fields by clicking the Last nameLast name field and moving it up

(press Alt+Up arrow key).

7. Save the entity. If you're asked whether you want to overwrite the existing entity or save it as a new entity,

click Over writeOver write.

8. Build the solution (press Ctrl+Shift+B).

9. In Internet Explorer, navigate to Fleet ManagementFleet Management > CustomersCustomers  > CustomerCustomer .

10. Click Open inOpen in Microsoft OfficeMicrosoft Office > Open in ExcelOpen in Excel  > Fleet Management CustomersFleet Management Customers .

11. Open the workbook that is generated.

12. Click Enable editingEnable editing to enable the Excel Data Connector App to load. Note that the Last nameLast name column

appears before the First nameFirst name column.

The Excel App is built by using a new Apps for Office framework. This framework provides a JavaScript-based

web application programming interface (API) that enables apps to communicate with Office applications. The

biggest advantage of this new framework is that apps can run in on-premises Excel instances (Win32), Excel

Online (Microsoft 365), and Excel on the Apple iPad. They will also be able to run in other Excel apps in the

future.

1. Navigate to Fleet ManagementFleet Management > CustomersCustomers  > CustomerCustomer .

2. Click Open inOpen in Microsoft OfficeMicrosoft Office > Open in ExcelOpen in Excel  > Fleet Management CustomersFleet Management Customers .

3. Click SharePointSharePoint.

4. Browse to the desired Microsoft SharePoint folder.

5. Click SaveSave. The default behavior is to open the file after it's saved. Note that the workbook opens in Excel

Online. In Excel Online, capabilities of the Excel App, such as refresh and publish, and the design experience,

should work just as they work in on-premises Excel instances.

Template options resemble the generated Open in Excel options. They are automatically added to forms when

the system finds templates that have the same first data source as the root data source in the form. A workbook

template can have multiple data sources. It can also have unbound content. The Open in Excel experiences are

listed on the Open inOpen in Microsoft OfficeMicrosoft Office menu. The Excel workbook designerExcel workbook designer  page provides an easy way to

get a generated Open in Excel experience for an entity. It also provides a mechanism getting a blank workbook

that contains just the Excel App and a pointer to the server.



Register a template as a system-defined templateRegister a template as a system-defined template

1. In Internet Explorer, navigate to CommonCommon > CommonCommon > Office integrationOffice integration > Excel workbookExcel workbook

designerdesigner .

2. Select the FleetCustomerFleetCustomer  entity.

3. Add all fields in the list of available fields to the list of selected fields.

4. Click Create workbookCreate workbook.

5. Open the workbook that is generated. This workbook contains the Excel Data Connector App, a binding to the

Fleet Management CustomerFleet Management Customer  entity, and a pointer to the server that the workbook was generated from.

6. Click Enable editingEnable editing to enable the Excel Data Connector App to load. Customer data is read from the OData

service on the server and added to the table.

7. Insert a blank row above the table, and enter Fleet CustomersFleet Customers  as the title.

8. Rename the worksheet FleetCustomersFleetCustomers .

9. Rearrange some of the fields in the table. Click DesignDesign to open the design experience.

10. Next to the FleetCustomerFleetCustomer  data source, there are buttons for editing and deleting the data source. Click

EditEdit to see the field list.

11. Select fields, and move them as you require. Set the order for the first three fields to FirstNameFirstName, LastNameLastName,

and DriverL icenseDriverL icense.

12. Click UpdateUpdate. Note that the field order is changed.

13. Click DoneDone.

14. Click the SettingsSettings  (gear) button.

15. Click Clear binding dataClear binding data so that the workbook contains no bound data.

16. Click OKOK.

17. Save the workbook as FleetCustomersBasic.xlsxFleetCustomersBasic.xlsx.

18. In Internet Explorer, navigate to CommonCommon > CommonCommon > Office integrationOffice integration > Document templatesDocument templates .

19. Click NewNew .

20. Browse to the file that you just saved.

21. Click OKOK. The template is added as a line in the templates table.

22. In the FleetCustomersBasicFleetCustomersBasic row, clear the Apply current record filterApply current record filter  check box, so that an unfiltered list

of customers will be loaded after the template is opened.

23. Change the Template display nameTemplate display name value to Fleet Customers BasicFleet Customers Basic.

24. Navigate to Fleet ManagementFleet Management > CustomersCustomers  > CustomerCustomer .

25. Click Open inOpen in Microsoft OfficeMicrosoft Office. Note that Fleet Customers BasicFleet Customers Basic is now an option in the Open in ExcelOpen in Excel

section. Click that option.

26. Open the workbook that is generated.

27. Click Enable editingEnable editing to enable the Excel Data Connector App to load. Customer data is read from the OData

service on the server and added to the table binding that you created.

Templates that are registered as system-defined templates are loaded at deployment. This behavior is useful for

independent software vendors (ISVs) and partners that want to package templates together with other model

artifacts.

1. Start Visual Studio 2015 by opening the previously created project where the model is set to FleetFleet

ManagementManagement, or create a new project.

2. Right-click the project, and then click AddAdd > New itemNew item.

3. Select the ResourceResource item type.

4. Set the name to FleetCustomersBasicTemplateFleetCustomersBasicTemplate.

5. Make sure that the FleetCustomersBasic.xlsx file is closed.



Journal Entry in Excel experience powered by a templateJournal Entry in Excel experience powered by a template

Lookups in Excel experiences
Lookups in the Excel AppLookups in the Excel App

this.addTemplate(
    OfficeAppApplicationType::Excel, 
    resourceStr(FleetCustomersBasicTemplate), 
    resourceStr(FleetCustomersBasicTemplate), 
    "Template for fleet customers", "Fleet customers basic", NoYes::No, NoYes::Yes);

6. Click AddAdd.

7. Select the FleetCustomersBasic.xlsxFleetCustomersBasic.xlsx file. Note that the resource is added to the project.

8. Click ViewView  > Application ExplorerApplication Explorer  (or press Ctrl+E, Ctrl+E).

9. Navigate to AOTAOT > ClassesClasses  > CodeCode > FMTemplateRegistrationsFMTemplateRegistrations .

10. Right-click FMTemplateRegistrationsFMTemplateRegistrations , and then click Add to projectAdd to project.

11. Open FMTemplateRegistrationsFMTemplateRegistrations . The FMTemplateRegistrations.xpp code file should be shown.

12. Copy one of the existing lines, and change it by providing the template name, resource name, description,

display name, and Apply current record filterApply current record filter  and L ist in Open in Office menuList in Open in Office menu values. The display

name is the text that appears as an Open in Excel option. The description appears when the user holds the

pointer over that item. The display name and description can be either labels or static strings. The code

should resemble the following example.

13. Save the code. If you're asked whether you want to overwrite the existing code or save it as a new file,

click Over writeOver write.

14. Build the solution (press Ctrl+Shift+B).

15. Verify that the change was successful. In Internet Explorer, navigate to CommonCommon > CommonCommon > OfficeOffice

integrationintegration > Document templatesDocument templates .

16. Click Reload system templatesReload system templates .

17. Click YesYes  to confirm that you want to reload the system templates.

18. Verify that the new system-defined template is loaded, and that the template name is

FleetCustomersBasicTemplateFleetCustomersBasicTemplate.

1. In Internet Explorer, navigate to General ledgerGeneral ledger  > Journal entr iesJournal entr ies  > General journalsGeneral journals .

2. Make sure that you're in company USMFUSMF.

3. Create a new journal by clicking NewNew .

4. Set the name to GenJrnGenJrn.

5. Click Open lines in ExcelOpen lines in Excel .

6. Open the workbook that is generated, and enable editing as required. Note that header fields are filled with

data.

7. Enter a new line, and set the MainAccountMainAccount field to 110110110110 . Enter a description, a currency, and a debit

amount. Note that lookups are provided for the company and currency fields, because those relationships

are defined for this entity.

8. Click PublishPublish . Note that the line is updated with the current date and a debit amount of 0 (zero).

9. In Internet Explorer, click L inesLines . Note that line that you entered in Excel is shown.

To facilitate data entry, the Excel App provides lookups and data assistance. Date fields provide a date picker,



Create a relationship lookupCreate a relationship lookup

enumeration (enum) fields provide an enum list, and relationships provide a relationship lookup.

1. In Internet Explorer, navigate to Fleet ManagementFleet Management > RentalsRentals  > RentalRental .

2. Click Open inOpen in Microsoft OfficeMicrosoft Office > Open in ExcelOpen in Excel  > Fleet Management RentalsFleet Management Rentals .

3. Open the workbook that is generated.

4. Click Enable editingEnable editing to enable the Excel Data Connector App to load and read in data.

5. Click a Drivers licenseDrivers license value. Note that a relationship lookup now appears in the Excel App and shows a list

of customers. Because relationship lookups are in their first generation, no filtering or sorting is currently

supported.

6. Click another customer in the lookup, and note that the Drivers licenseDrivers license value changes. Because this field is

part of the key, click the original Drivers licenseDrivers license value to reset it. Note that the Drivers licenseDrivers license, FirstFirst

namename, and Last nameLast name fields form a multi-part key, but the Excel App doesn’t immediately change all parts

of the multi-part key.

7. Click a Star t dateStar t date value. Note that a date picker now appears in the Excel App.

8. Click another date to change the Star t dateStar t date value.

9. Click DesignDesign, and edit the FleetRental data source by adding the StatusStatus  field as a column in the table

binding.

10. When you've finished adding the StatusStatus  column, click a StatusStatus  value. Note that an enum list now appears in

the Excel App.

11. While focus is in the StatusStatus  column, move up and down the list of rentals to see how quickly the enum list

changes to reflect the current value. The whole enum list is shown, so that the user can quickly see all the

available values.

12. Click a different StatusStatus  value to see how an enum value can be changed by using a single click.

When relationships exist between entities, a relationship lookup is shown.

1. Start Visual Studio 2015 by opening the previously created project where the model is set to FleetFleet

ManagementManagement, or create a new project.

2. Click ViewView  > Application ExplorerApplication Explorer  (or press Ctrl+E, Ctrl+E).

3. Navigate to AOTAOT > Data ModelData Model  > TablesTables  > FMCustGroupFMCustGroup.

4. Right-click, and then click Open designerOpen designer .

5. In the designer, right-click FMCustGroupFMCustGroup, and then click Add-insAdd-ins  > Create data entityCreate data entity . Artifacts are added

to the project.

6. Open the designer view for FMCustGroupEntityFMCustGroupEntity .

7. In the property sheet for FMCustGroupEntityFMCustGroupEntity , set Public Collection NamePublic Collection Name to FleetCustomerGroupsFleetCustomerGroups

and Public Entity NamePublic Entity Name to FleetCustomerGroupFleetCustomerGroup.

8. Add the CustGroupCustGroup and Descr iptionDescr iption fields to the AutoLookupAutoLookup field group.

9. If FMCustomerEntityFMCustomerEntity  isn't already in the project, add it.

10. Open the designer view for FMCustomerEntityFMCustomerEntity .

11. Right-click RelationsRelations , and then click NewNew  > RelationRelation.

12. On the new relation, set NameName to CustomerGroupCustomerGroup, CardinalityCardinality  to ZeroMoreZeroMore, RelatedDataEntityRelatedDataEntity  to

FMCustGroupEntityFMCustGroupEntity , RelatedDataEntityCardinalityRelatedDataEntityCardinality  to ZeroOneZeroOne, RelationshipTypeRelationshipType to AssociationAssociation,

RoleRole to CustomerGroupSourceCustomerGroupSource, and RelatedDataEntityRoleRelatedDataEntityRole to CustomerGroupTargetCustomerGroupTarget.

13. Build the solution (press Ctrl+Shift+B).

14. Verify that the change was successful. In Internet Explorer, navigate to Fleet ManagementFleet Management > CustomersCustomers  >

CustomerCustomer .

15. Click Open inOpen in Microsoft OfficeMicrosoft Office > Open in ExcelOpen in Excel  > Fleet Management CustomersFleet Management Customers .

16. Open the workbook that is generated.

17. Click a Customer groupCustomer group value.



Create a custom lookupCreate a custom lookup

Export to Word experiences
Export to WordExport to Word

18. Change the Customer groupCustomer group value for a customer.

19. Publish the change.

20. Change the value back, and publish that change.

You can create custom lookups to show data options when an enum or relationship isn't sufficient. The main use

case is when data must be retrieved from an external service and presented in real time.

  public class FMCustomerEntity extends common
{
   [SysODataActionAttribute("FMCustomerEntityCountryCustomLookup", false), //Name in $metadata
   SysODataCollectionAttribute("_fields", Types::String), //Types in context
   SysODataFieldLookupAttribute("Country")] //Name of field
   public static str lookup_Country(Array _fields)
 {
  OfficeAppCustomLookupListResult result = new OfficeAppCustomLookupListResult();

  result.items().value(1, "US");
  result.items().value(2, "AU");
  result.items().value(3, "FR");
  result.items().value(4, "GR");
  result.items().value(5, "NZ");

  return result.serialize();
 }
  }

1. Start Visual Studio 2015 by opening the previously created project where the model is set to FleetFleet

ManagementManagement, or create a new project.

2. Open the designer view for FMCustomerEntityFMCustomerEntity .

3. Right-click MethodsMethods , and then click New MethodNew Method.

4. Add the lookup_Countr ylookup_Countr y  code from the following example.

5. Save the code. If you're asked whether you want to overwrite the existing code or save is as a new file,

click Over writeOver write.

6. Build the solution (press Ctrl+Shift+B).

7. Verify that the change was successful. In Internet Explorer, navigate to Fleet ManagementFleet Management >

CustomersCustomers  > CustomerCustomer .

8. Click Open inOpen in Microsoft OfficeMicrosoft Office > Open in ExcelOpen in Excel  > Fleet Management CustomersFleet Management Customers .

9. Open the workbook that is generated.

10. Click a Countr yCountr y  value.

11. Change the Countr yCountr y  value for a customer.

12. Publish the change.

13. Change the value back, and publish that change.

Export to Word experiences can be used for lightweight reporting. They are powered by pre-built templates. The

Export to Word experiences are listed on the Open inOpen in Microsoft OfficeMicrosoft Office menu. Let's look at an example



Create a Word templateCreate a Word template

experience that has been created for Fleet Management Customers.

1. In Internet Explorer, navigate to Fleet ManagementFleet Management > CustomersCustomers  > CustomerCustomer .

2. Click Open inOpen in Microsoft OfficeMicrosoft Office > Expor t to WordExpor t to Word > Customer information Fleet ManagementCustomer information Fleet Management

Customers (unfiltered)Customers (unfiltered) .

3. Download and open the document that is generated. The document contains data from the record that is

currently selected.

The Microsoft Dynamics App for Office can be run in Word to enable the creation of templates that can then be

used for document generation.

1. Add a trusted catalog that points to the file share that contains the Microsoft Dynamics App manifest:

a. In Word, click FileFile > OptionsOptions .

b. Click Trust CenterTrust Center  > Trust Center SettingsTrust Center Settings .

c. Click Trusted Add-in CatalogsTrusted Add-in Catalogs .

d. In the Catalog URLCatalog URL  field, enter the file share location of the manifest.

e. Click Add catalogAdd catalog.

f. Click OKOK.

g. Click OKOK.

h. Restart Word.

2. Add the Microsoft Dynamics App to a document:

a. In Word, click Inser tInser t > My Add-insMy Add-ins  > Shared FolderShared Folder  > Microsoft DynamicsMicrosoft Dynamics .

b. Click Inser tInser t.

c. In the app, click Add ser ver informationAdd ser ver information.

d. In the Ser ver URLSer ver URL  field, enter the start of the URL (protocol + hostname). For example, enter 

https://topo00dfa4stbobaos.cloudax.test.dynamics.com .

e. Click OKOK.

f. Click YesYes  to apply the settings change and reload the app.

3. Sign in to the app:

a. Click S ign InSign In . The Azure Active Directory sign-in screen should provide a list of credentials. If you

encounter an error, force a sign-out (by using the sign-out link in the lower-right corner of the app),

and then sign in again.

b. Select the appropriate account, or click Use another accountUse another account.

c. Enter the credentials for that environment, and then click S ign inSign in .

4. Load the template designer applet:

a. After sign-in, click Load appletsLoad applets .

b. Select Template DesignerTemplate Designer .

c. Click OK.OK.

d. Click YesYes  to confirm.

e. Click OKOK to close the settings page. The latest OData metadata is loaded.

5. Follow one of these steps:

Add a fields data source:

a. In the app, click DesignDesign.

b. Click Add fieldsAdd fields .

c. Select FleetCustomerFleetCustomer .

d. Click NextNext to go to the field selection page.



Create a Word template and use it for document generationCreate a Word template and use it for document generation

Document Management and SharePoint experiences
Add a SharePoint document typeAdd a SharePoint document type

Add a table data source:

e. In the document, add a title and/or some blank lines at the top of the document.

f. In the app, in the AvailableAvailable list, select the FirstNameFirstName field.

g. Click Add labelAdd label  to add a content control that references the "First name" label.

h. In the document, click to put focus into the document, click again to put focus at the end of the

label, and then press the Right arrow key until the cursor is outside the content control (the

control box will disappear).

i. Add a separator, such as space+hyphen+space (" - ") or space+colon+space (" : ").

j. In the app, click Add valueAdd value to add a content control that references the FirstNameFirstName field.

k. Repeat the process for the LastNameLastName field label and value.

l. Continue to add fields as desired.

a. In the app, click DesignDesign.

b. Click Add tableAdd table.

c. Select FleetCustomerFleetCustomer .

d. Click NextNext to go to the field selection page.

e. In the document, add a title and/or some blank lines at the top of the document.

f. In the app, in the Available fieldsAvailable fields  list, add the FirstNameFirstName, LastNameLastName, and CityCity  fields.

g. Click DoneDone.

6. In Word, save the template document.

After you've built a Word template, you can upload it to create an Export to Word experience.

1. Upload a template:

a. Navigate to CommonCommon > CommonCommon > Office integrationOffice integration > Document templatesDocument templates . Alternatively,

search for the page.

b. Click NewNew .

c. Click BrowseBrowse.

d. In the dialog box, select a previously created template, and then click OpenOpen. Note that the Root data

entity is obtained from the template and appears near the bottom of the dialog box.

e. Click OKOK.

f. Scroll down the list of templates to confirm that the template was added.

g. Optional: If the template should not be filtered to the user's current record, clear the Apply currentApply current

record filterrecord filter  check box.

h. Optional: If the template should not be filtered to the user's current company, clear the ApplyApply

company filtercompany filter  check box.

2. Use the uploaded template for document generation:

a. Navigate to a page that shares the same root data source as the template's root data entity. For

FleetCustomerFleetCustomer  (FMCustomerEntityFMCustomerEntity ), that page is Fleet ManagementFleet Management > CustomersCustomers  >

CustomerCustomer .

b. Click Open in Microsoft OfficeOpen in Microsoft Office > Expor t to WordExpor t to Word, and click the template.

c. Download and open the document that is generated.

The Document Management subsystem can be used to attach files to records. Most non-executable file types are

supported as attachments. A document preview is provided for Office document files and PDFs. Administrators



Email experiences
Send mail via a local mail clientSend mail via a local mail client

create document types to indicate where attachments should be stored. When administrators use SharePoint as

the storage location, they must provide a specific folder that the files should be put in. Security of that

SharePoint folder is a separate administration responsibility.

1. In Internet Explorer, navigate to Organization administrationOrganization administration > Document managementDocument management > DocumentDocument

management parametersmanagement parameters .

2. Click SharePointSharePoint.

3. Make sure that the Default SharePoint ser verDefault SharePoint ser ver  field is set to a default value for the tenant, such as

contosoax7.sharepoint.comcontosoax7.sharepoint.com.

4. Click Test SharePoint connectionTest SharePoint connection. Note a successful connection.

5. Click SaveSave.

6. Navigate to Organization administrationOrganization administration > Document managementDocument management > Document typesDocument types .

7. Click NewNew .

8. Set TypeType to SharePointDocSharePointDoc.

9. Set NameName to SharePointDocSharePointDoc.

10. Set LocationLocation to SharePointSharePoint.

11. Click the EditEdit (pencil) button next to the SharePoint AddressSharePoint Address  field.

12. On the left side of the dialog box, select a site. For the contosoax7 tenant, select ContosoAX Team SiteContosoAX Team Site.

13. On the right side of the dialog box, select a folder. For the contosoax7 tenant, select ContosoAX Team SiteContosoAX Team Site

> DocumentsDocuments  > OfficeIntegrationOfficeIntegration > AttachmentsAttachments .

14. Click OKOK.

15. Click SaveSave.

16. Click the BrowseBrowse (globe) button next to the SharePoint AddressSharePoint Address  field. Note that a new browser tab that

shows the selected folder appears.

17. Use Windows Explorer to create a Word document in the Documents folder, and enter a few words in the

document.

18. In Internet Explorer, navigate to Fleet ManagementFleet Management > CustomersCustomers  > CustomerCustomer .

19. Put focus on the first customer, and then click the AttachAttach (paperclip) button in the upper-right corner of the

page.

20. Click NewNew  > SharePointDocSharePointDoc.

21. Click BrowseBrowse, and select the Word document that you created.

22. Expand the PreviewPreview  FastTab to see a preview of the Word document.

23. Expand the AttachmentAttachment FastTab to see the file location of the Word document.

24. In Internet Explorer, use the previously opened tab that shows the SharePoint folder to double-check that the

file has been placed appropriately.

Email workflows that are enabled via the SysEmail framework can generate email messages (.eml files) that

contain attachments. You can then send these messages via Microsoft Outlook or another email client.

1. In Internet Explorer, navigate to Accounts receivableAccounts receivable > CustomersCustomers  > All customersAll customers .

2. Select US-008 Sparrow RetailUS-008 Sparrow Retail .

3. Click CollectCollect > Customer balancesCustomer balances  > CollectionsCollections  to open the CollectionsCollections  page.

4. Click CommunicateCommunicate > EmailEmail  > Statements to contactStatements to contact.

5. Click OKOK to accept the default values in the dialog box.

6. If you're prompted for the mail option to use, clear the Do not ask againDo not ask again check box (you can change this

option from the user options page), select Use an email app, such as OutlookUse an email app, such as Outlook, and then click OKOK.



Send mail via SMTPSend mail via SMTP

7. If you're running Internet Explorer on your laptop, open the email (.eml) file that is generated. If you're

running Internet Explorer on the VM, copy the file to your laptop, and open it there.

8. Note the email address in the ToTo field and the generated workbook attachment.

Email workflows that are enabled via the SysEmail framework can also be created in a simple email dialog box

and then sent via Simple Mail Transfer Protocol (SMTP).

1. In Internet Explorer, navigate to System administrationSystem administration > SetupSetup > EmailEmail  > Email parametersEmail parameters .

2. Click SMTP settingsSMTP settings .

3. Set the Outgoing mail ser verOutgoing mail ser ver  to the desired SMTP server :

For Microsoft 365 production (including *.onmicrosoft.com accounts): smtp.office365.com (Find this

setting via outlook.office.com, at SettingsSettings  > MailMail  > POP and IMAPPOP and IMAP.)

For Outlook/Hotmail: smtp-mail.outlook.com

4. Set the user name and password to an appropriate email account and password.

5. Leave SSLRequiredSSLRequired turned on, and leave SMTP por t numberSMTP por t number  set to 587587 .

6. Click SaveSave.

7. In Internet Explorer, navigate to Accounts receivableAccounts receivable > CustomersCustomers  > All customersAll customers .

8. Select US-008 Sparrow RetailUS-008 Sparrow Retail .

9. Click CollectCollect > Customer balancesCustomer balances  > CollectionsCollections  to open the CollectionsCollections  page.

10. Click CommunicateCommunicate > EmailEmail  > Statements to contactStatements to contact.

11. Click OKOK to accept the default values in the dialog box.

12. If you're prompted for the mail option to use, select Use the Microsoft Dynamics 365 for FinanceUse the Microsoft Dynamics 365 for Finance

and Operations email clientand Operations email client, and then click OKOK.

13. To receive the test message, change the To address to your email address.

14. Enter a subject and body for the message.

15. Click SendSend. The message should be delivered in one to five minutes. Note that the message will appear to

be sent from the email account that is set on the Email parametersEmail parameters  page. If that email account is given

"Send As" (or "Send email from this mailbox") permissions for the From address that is used in the SendSend

emailemail  dialog box, messages will appear to come from that address.

You can configure "Send As" permissions in the Microsoft 365 admin center

(portal.office.com/Admin), at UsersUsers  > Active usersActive users  > UserUser  > Edit mailbox permissionsEdit mailbox permissions  > SendSend

email from this mailboxemail from this mailbox. For more information, see Enable sending email from another user's

mailbox in Microsoft 365.

Before users can send email messages, "Send As" permissions for each user email account in the client

must be given to the email account that is set on the Email parametersEmail parameters  page. For more information,

see How to set up a multifunction device or application to send email using Microsoft 365.

16. Email that is sent directly from the server, without user interaction, is sent via a batch process and

requires that the Email distr ibutor batchEmail distr ibutor batch process be started. Follow these steps to start the process:

a. Navigate to System administrationSystem administration > Periodic tasksPeriodic tasks  > Email processingEmail processing > BatchBatch.

b. Turn on Batch processingBatch processing.

https://support.office.com/article/Outlook-settings-for-POP-and-IMAP-access-for-Office-365-for-business-or-Microsoft-Exchange-accounts-7fc677eb-2491-4cbc-8153-8e7113525f6c
https://support.office.com/article/Enable-sending-email-from-another-user-s-mailbox-in-Office-365-2B828C5F-41AB-4904-97B9-3B63D8129C4E
https://technet.microsoft.com/library/dn554323(v=exchg.150).aspx


Additional resources

NOTENOTE

Office integration overview

Troubleshoot the Office integration

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

NOTENOTE

Open entity data in Excel when you start from a Finance and
Operations app

Applies to these Dynamics 365 appsApplies to these Dynamics 365 apps :

Commerce, Finance, Supply Chain Management

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see Service update availability.

This topic explains how to open entity data in Microsoft Excel, and then view, update, and edit the data by using

the Microsoft Dynamics Excel add-in. To open entity data, you can start from either Excel or Finance and

Operations apps.

By opening entity data in Excel, you can quickly and easily view and edit the data by using the Excel add-in. This

add-in requires Microsoft Excel 2016 or later.

If your Microsoft Azure Active Directory (Azure AD) tenant is configured to use Active Directory Federation Services

(AD FS), you must make sure that the May 2016 update for Office has been applied, so that the Excel add-in can correctly

sign you in.

To learn more about how to use the Excel add-in, watch the short Create an Excel template for header and line

patterns video.

1. On a page in a Finance and Operations app, select Open in Microsoft OfficeOpen in Microsoft Office.

If the root data source (table) for the page is the same as the root data source for any entities, default

Open in ExcelOpen in Excel  options are generated for the page. Open in ExcelOpen in Excel  options can be found on frequently

used pages, such as All vendorsAll vendors  and All customersAll customers .

2. Select an Open in ExcelOpen in Excel  option, and open the workbook that is generated. This workbook has binding

information for the entity, a pointer to your environment, and a pointer to the Excel add-in.

3. In Excel, select Enable editingEnable editing to enable the Excel add-in to run. The Excel add-in runs in a pane on the

right side of the Excel window.

4. If you're running the Excel add-in for the first time, select Trust this Add-inTrust this Add-in .

5. If you're prompted to sign in, select S ign inSign in , and then sign in by using the same credentials that you used

to sign in to the Finance and Operations app. The Excel add-in will use a previous sign-in context from the

browser and automatically sign you in, if it can. (For information about the browser that is used based on

the operating system, see Browsers used by Office add-ins To ensure that sign-in was successful, verify

the user name in the upper-right corner of the Excel add-in.

The Excel add-in automatically reads the data for the entity that you selected. Note that there will be no data in

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/office-integration/use-excel-add-in.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/public-preview-releases
https://youtu.be/RTicLb-6dbI
https://docs.microsoft.com/en-us/office/dev/add-ins/concepts/browsers-used-by-office-web-add-ins.


Open entity data in Excel when you start from Excel

View and update entity data in Excel

Edit entity data in Excel

the workbook until the Excel add-in reads it in.

1. In Excel, on the Inser tInser t tab, in the Add-insAdd-ins  group, select StoreStore to open the Office Store.

2. In the Office Store, search on the keyword DynamicsDynamics , and then select AddAdd next to Microsoft DynamicsMicrosoft Dynamics

Office Add-inOffice Add-in (the Excel add-in).

3. If you're running the Excel add-in for the first time, select Trust this Add-inTrust this Add-in to enable the Excel add-in to

run. The Excel add-in runs in a pane on the right side of the Excel window.

4. Select Add ser ver informationAdd ser ver information to open the OptionsOptions  pane.

5. In your browser, copy the URL of your target Finance and Operations app instance, paste it into the

Ser ver URLSer ver URL  field, and then delete everything after the host name. The resulting URL should have only

the host name.

For example, if the URL is https://xxx.dynamics.com/?cmp=usmf&amp;mi=CustTableListPage , delete

everything except https://xxx.dynamics.com .

6. Select OKOK, and then select YesYes  to confirm the change. The Excel add-in is restarted and loads metadata.

The DesignDesign button is now available. If the Excel add-in has a Load appletsLoad applets  button, you probably aren't

signed in as the correct user. For more information, see "The Load applets button is shown" in the

Troubleshooting section of this topic.

7. Select DesignDesign. The Excel add-in retrieves entity metadata.

8. Select Add tableAdd table. A list of entities appears. The entities are listed in "Name - Label" format.

9. Select an entity in the list, such as Customer - CustomersCustomer - Customers , and then select NextNext.

10. To add a field from the Available fieldsAvailable fields  list to the Selected fieldsSelected fields  list, select the field, and then select

AddAdd. Alternatively, double-click the field in the Available fieldsAvailable fields  list.

11. After you've finished adding fields to the Selected fieldsSelected fields  list, make sure that the cursor is in the correct

place in the worksheet (for example, cell A1), and then select DoneDone. Then select DoneDone to exit the designer.

12. Select RefreshRefresh to pull in a set of data.

After the Excel add-in reads entity data into the workbook, you can update the data at any time by selecting

RefreshRefresh in the Excel add-in.

You can change entity data as you require and then publish it back to Finance and Operations apps by selecting

PublishPublish in the Excel add-in. To edit a record, select a cell in the worksheet, and then change the cell value. To add

a new record, follow one of these steps:

Click anywhere in the data sources table, and then select NewNew  in the Excel add-in.

Click anywhere in the last row of the data sources table, and then press the Tab key until the cursor moves

out of the last column of that row and a new row is created.

Click anywhere in the row immediately below the data sources table, and start to enter data in a cell. When

you move the focus out of that cell, the table expands to include the new row.

For field bindings of header records, select one of the fields, and then select NewNew  in the Excel add-in.

https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/office-integration/use-excel-add-in#troubleshooting


Add or remove columns

NOTENOTE

Change the publish batch size

Note that a new record can be created only if all the key and mandatory fields are bound in the worksheet, or if

default values were filled in by using the filter condition.

To delete a record, follow one of these steps:

Right-click the row number next to the worksheet row that should be deleted, and then select DeleteDelete.

Right-click anywhere in the worksheet row that should be deleted, and then select DeleteDelete > Table RowsTable Rows .

If data sources have been added as related data sources, the header is published before the lines. If there are

dependencies between other data sources, you might have to change the default publishing order. To change the

publishing order, in the Excel add-in, select the OptionsOptions  button (the gear symbol), and then, on the DataData

ConnectorConnector  FastTab, select Configure publish orderConfigure publish order .

You can use the designer to adjust the columns that are automatically added to the worksheet.

If the DesignDesign button doesn't appear below the FilterFilter  button in the Excel add-in, you must enable the data source

designer. Select the OptionsOptions button (the gear symbol), and then select the Enable designEnable design check box.

1. In the Excel add-in, select DesignDesign. All the data sources are listed.

2. Next to the data source, select the EditEdit button (the pencil symbol).

3. In the Selected fieldsSelected fields  list, adjust the list of fields as you require:

To add a field from the Available fieldsAvailable fields  list to the Selected fieldsSelected fields  list, select the field, and then select

AddAdd. Alternatively, double-click the field in the Available fieldsAvailable fields  list.

To remove a field from the Selected fieldsSelected fields  list, select the field, and then select RemoveRemove. Alternatively,

double-click the field.

To change the order of fields in the Selected fieldsSelected fields  list, select a field, and then select UpUp or DownDown.

4. To apply your changes to the data source, select UpdateUpdate. Then select DoneDone to exit the designer.

5. If you added a field (column), select RefreshRefresh to pull in an updated set of data.

When users publish changes to data records by using the Excel add-in, the updates are submitted in batches.

The default publish batch size is 100 rows. In version 10.0.17 and later, the Allow configuration of theAllow configuration of the

publish batch size in the Excel add-inpublish batch size in the Excel add-in feature gives you flexible control over the publish batch size.

System administrators can specify a system-wide limit on the publish batch size for "Open in Excel" workbooks

by setting the Publish batch limitPublish batch limit field in the App parametersApp parameters  section of the Office app parametersOffice app parameters  page.

The publish batch size can also be changed for an individual workbook by using the Excel add-in.

1. Open the workbook in Excel.

2. Select the OptionOption (gear) button in the upper right of the Excel add-in.

3. Set the Publish batch sizePublish batch size field as desired. The value that you set must be less than the system-wide

publish batch limit.

4. Select OKOK.

5. Save the workbook. If you don't save the workbook after you make changes to the add-in settings, those

changes won't persist when the workbook is reopened.



Copy environment data

Troubleshooting

NOTENOTE

Excel workbook template authors can use the same procedure to set the publish batch size for templates before

they upload them into the system.

The data that is read into the workbook from one environment can be copied to another environment. However,

you can't just change the connection URL, because the data cache in the workbook will continue to treat the data

as existing data. Instead, you must use the Copy Environment Data functionality to publish the data to a new

environment as new data.

1. Select the OptionsOptions  button (the gear symbol), and then, on the Data ConnectorData Connector  FastTab, select CopyCopy

Environment DataEnvironment Data.

2. Enter the server URL for the new environment.

3. Select OKOK, and then select YesYes  to confirm the action. The Excel add-in is restarted and connects to the

new environment. Any existing data in the workbook is treated as new data.

After the Excel add-in is restarted, a message box states that the workbook is in Environment copy mode.

4. To copy the data into the new environment as new data, select PublishPublish . To cancel the environment copy

operation and review the existing data in the new environment, select RefreshRefresh.

There are a few issues that can be resolved through some easy steps.

The Load applets button is shownThe Load applets button is shown – If the Excel add-in has a Load appletsLoad applets  button after sign-in, you

probably aren't signed in as the correct user. To resolve this issue, verify that the correct user name appears in

the upper-right corner of the Excel add-in. If an incorrect user name appears, select it, sign out, and then sign

back in.

You receive a "Forbidden" messageYou receive a "Forbidden" message – If you receive a "Forbidden" message while the Excel add-in is

loading metadata, the account that is signed in to the Excel add-in doesn't have permission to use the

targeted service, instance, or database. To resolve this issue, verify that the correct user name appears in the

upper-right corner of the Excel add-in. If an incorrect user name appears, select it, sign out, and then sign

back in.

A blank webpage is shown over ExcelA blank webpage is shown over Excel  – If a blank webpage is opened during the sign-in process, the

account requires AD FS, but the version of Excel that is running the Excel add-in isn't recent enough to load

the sign-in dialog box. To resolve this issue, update the version of Excel that you're using. To update the

version of Excel when you're in an enterprise that is on the deferred channel, use the Office deployment tool

to move from the deferred channel to the current channel.

You receive a time-out while you publish data changesYou receive a time-out while you publish data changes  – If you receive time-out messages while

you're trying to publish data changes to an entity, consider reducing the publish batch size for the affected

workbook. Entities that trigger larger amounts of logic on record changes might require updates to be sent

in smaller batches to help prevent time-outs.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://technet.microsoft.com/library/jj219422.aspx
https://technet.microsoft.com/library/mt455210.aspx
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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What are Open in Excel experiences?

Where are the Open in Excel experiences?

What's the difference between Export to Excel and Open in Excel?

Applies to these Dynamics 365 appsApplies to these Dynamics 365 apps :

Commerce, Finance, Human Resources, Supply Chain Management

Learn about creating Open in Office experiences for Excel and Word.

Open in Excel experiences are:

Based on entities and the OData services that they create.

Dynamically-generated or based on a pre-defined template.

Editable and refreshable via the Excel Add-in.

The following image shows the Excel Add-inExcel Add-in being used for Journal entry.

Open in Excel experiences are usually found under in the Open in Excel section of the Open in Microsoft Office

menu, but an explicit button can be added for these experiences.

The Export to Excel options and experiences are both found in the Open in Microsoft Office menu:

The Export to Excel options are static exports of grid data. Each one corresponds to a visible grid. All the grid

data for the current filter is placed into a workbook.

The Open in Excel experiences utilize the Excel Add-in to facilitate refresh and publish.

The following image shows the Open in Microsoft OfficeOpen in Microsoft Office menu on the Fleet CustomersFleet Customers  form with a

template Open in ExcelOpen in Excel  option, a generated Open in ExcelOpen in Excel  option, and a static Expor t to ExcelExpor t to Excel  option.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/office-integration/office-integration-edit-excel.md
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/office-integration/media/off101a.png


When will an entity show as an Open in Excel option?

What fields will be shown in the workbook?

What fields will be shown when an entity is the target of a lookup?

When an entity has the same root datasource (table) as a form, it will be added as an option in the Open in Excel

section of the Open in Microsoft Office menu. This is referred to as a “generated” option.

The default fields that will be added into the workbook are the key and mandatory fields of the entity. If a

different set of fields should be provided by default, then those fields can be added into the AutoRepor t fieldAutoRepor t field

groupgroup on the entity. The following image shows the Visual Studio view of the AutoReport field group for the

FMCustomerEntity.

When a relationship is defined between two entities, if the identifier for one entity is shown on the other entity,

then the fields that will be shown in that lookup are either the key fields, or the fields in the AutoLookup fieldAutoLookup field

groupgroup if it is not empty. Relationship lookups are not currently supported, but they will eventually be displayed

in the app in a similar way to the enumeration lookups. The Excel Add-in with an enumeration lookup is shown

below.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/office-integration/media/off101b.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/office-integration/media/off101c.png


What should be done to make an entity ready for use in Excel?

Why does an automatically added entity option have “(unfiltered)”
after the entity name?

How can an entity be added as an Open in Excel option on a form
that doesn’t share the same root datasource?

What are the region-specific considerations for defining entities?

How can I create a custom lookup for an entity field in Excel?

Define the AutoReport and AutoLookup field groups and test them using the Excel App design experience.

Currently, a filter is not added to these options, hence the term “(unfiltered)”. In the future, an attempt will be

made to apply the filter from the form to these options. For example, if a list of Customers was filtered to just

Customers in the state of California, then, in the future, the entity will be scanned for the state field and if it is

found then a filter would be added automatically.

A generated Open in Excel option can be added on any form by implementing the

OfficeIGeneratedWorkbookCustomExporter interface. When adding a generated option programmatically, the

set of fields can be explicitly specified. For more information, see Modifying the Open in Office menu through

interfaces.

The Open in Excel generated experiences can be made region-specific by adding region-specific fields into the

AutoLookup group. These region-specific fields will then be included in the generated workbook.

A custom lookup can be shown for an Entity field.

Name - The method needs to have a name that is “lookup_<fieldname>” e.g. a field “MyField” could have a

lookup method “lookup_MyField”.

Attributes – Attributes need to be added to the method:
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public class ExportToExcel_SimpleEntity extends common
{
    [SysODataActionAttribute("Lookup_StringLookupField", true),
    SysODataCollectionAttribute("return", Types::String, "Value")]
    public List lookup_StringLookupField()
    {
        List lookupList = new List(Types::String);
        const int items = 5;

        for (int item = 0; item < items; item++)
        {
            lookupList.addEnd(strfmt('%1 - %2 (%3)', this.StringField, this.IntField, item));
        }

        return lookupList;
    }
}

How does the app get injected into a workbook to start building a
template?

Return – The method should return a list of strings.

SysODataActionAttribute(str <name>, Boolean <isInstanceMethod>)

SysODataCollectionAttribute(str <name>, Types <type>, “Value”)

ExampleExample

The Excel Add-in is injected into a workbook when a generated Open in Excel experience is triggered or when a

workbook is created using the CommonCommon > CommonCommon > Office integrationOffice integration > Excel workbook designerExcel workbook designer

form.

The Create workbookCreate workbook button will add the selected entity and fields, a pointer to the server, and the app into

a workbook.

The Create blank workbookCreate blank workbook button will simply add a pointer to the server and the app into a workbook.

The View relatedView related form will navigate to the form relating to the currently selected entity to more easily

review the effect of data changes made in Excel.

The Get entity record countGet entity record count button will show the record count for the currently selected entity. The Excel

Add-in will handle large sets of data within the memory limits of a user's machine. By default, the Excel Add-

in has a data governor that restricts the data size to one million cells but, depending on the performance

abilities of the user's machine, this can usually be extended to around 2.5 million cells.

The following image shows the Excel workbook designerExcel workbook designer  form.



When will a template show as an Open in Excel option?

Will a filter be added to the template?

How can templates be defined in metadata and code and loaded
automatically?

After obtaining a workbook containing the Excel Add-in, additional datasources can be added using the DesignDesign

button. Currently, datasources cannot be removed.

When a template listed in the CommonCommon > CommonCommon > Office integrationOffice integration > Document templatesDocument templates  form

(DocuTemplate) has ShowInOpenInOfficeMenu set to Yes and has the same root datasource (table) as the

current form, it will be added as an option in the Open in Excel section of the Open in Microsoft Office menu.

The following image shows the Document templatesDocument templates  form.

In the Document TemplatesDocument Templates  form, the standard filter for “current record” can be turned on and off. If the filter

is on, when the template is invoked as an Open in Excel option, then a filter for the current record will be added

to the workbook. The filter will be the key fields and their values.

When adding a template into the Document TemplatesDocument Templates  form, it is added for that instance and is referred to as

a “user-defined” template. Templates can also be defined in metadata and code and loaded automatically, thus

making them “system-defined” templates. To create a system-defined template using metadata and code, you

need to do the following:

Define the template.

Create a new resource in a project.

Define a new class that extends the DocuTemplateRegistrationBase class and add an implementation of the

registerTemplates method.

The LedgerJournalLineEntryTemplateRegistration and FMTemplateRegistrations classes are good examples of
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How do templates get loaded into a fresh deployment?

How do I decide if I should create a template?

What are the region-specific considerations for templates?

How do I add an explicit button for a template Open in Excel option?

template registrations defined in code. The LedgerJournalLineEntryTemplate and

FMTemplateCustomersWithLocations resources are the corresponding templates stored in metadata as

resources. When a template has a registration class, it will be loaded when the Reload system templatesReload system templates

button is clicked in the Document TemplatesDocument Templates  form.

To load system defined templates, click the Reload system templatesReload system templates  button in the CommonCommon > CommonCommon >

Office integrationOffice integration > Document templatesDocument templates  form, as shown below.

In the future, we will do the equivalent of clicking that button during deployment.

A template is an artifact that needs to be maintained and versioned. If you can avoid defining a template without

sacrificing much from the user experience, then you probably should use a template. Create a template if:

You need additional content or formatting in the template.

You want to combine multiple entities/datasources in the same workbook.

Don’t create a template if:

You can just specify a set of fields to show in a table binding.

When creating a template for an entity that has region-specific fields, you should leave those region-specific

fields out of the template, otherwise all users will see the region-specific fields. Templates should cater to the

majority of users by default and region-specific users can add those fields using the easy-to-use design

experience of the Excel Add-in. The region-specific fields and columns can be added by users as needed. That

template can be either saved to local computer for reuse by a single user or uploaded via the Document

Templates form for reuse by any user of that instance. A couple of other considerations:

If a region has a region-specific entity, then a region-specific template could be created.

If a region is important enough, then you could define a region-specific template as well as a region-generic

template.

An explicit button can be added for Open in Excel experiences. The label shown on the button should usually be

“Open target in Excel” where target is the name of the target data like “lines” or “catalog”. The code behind such

a button will:

Obtain the template to be used.

Add a filter.

Pass the template to the user.

An example of this code can be found on the LedgerJournalTableLedgerJournalTable form (General ledgerGeneral ledger  > JournalsJournals  >

General journalGeneral journal ) in the ClickedClicked method on the OpenLinesInExcelOpenLinesInExcel  button.

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/office-integration/media/off101h.png


[Control("Button")]
class OpenLinesInExcel
{

    /// <summary>
    /// Opens the current journal in Excel for line entry and editing
    /// </summary>
    public void clicked()
    {
        super();

        const str templateName = resourceStr(LedgerJournalLineEntryTemplate);
                DocuTemplate template = DocuTemplate::findTemplate(OfficeAppApplicationType::Excel, 
templateName);

        // Ensure the template was present
        if (template && template.TemplateID == templateName)
        {
            Map filtersToApply = new Map(Types::String, Types::String);

            // Create lines filter
            ExportToExcelFilterBuilder filterBuilder = new 
ExportToExcelFilterBuilder(tablestr(LedgerJournalLineEntity));
            str filterString = filterBuilder.areEqual(fieldstr(LedgerJournalLineEntity, JournalBatchNumber), 
LedgerJournalTable.JournalNum);
            filtersToApply.insert(tablestr(LedgerJournalLineEntity), filterString);

            // Create header filter
            filterBuilder = new ExportToExcelFilterBuilder(tablestr(LedgerJournalHeaderEntity));
            filterString = filterBuilder.areEqual(fieldstr(LedgerJournalHeaderEntity, JournalBatchNumber), 
LedgerJournalTable.JournalNum);
            filtersToApply.insert(tablestr(LedgerJournalHeaderEntity), filterString);

            // Generate the workbook using the template and filters
            DocuTemplateRender renderer = new DocuTemplateRender();
            str documentUrl = renderer.renderTemplateToStorage(template, filtersToApply);

            // Pass the workbook to the user
            if (documentUrl)
            {
                Browser b = new Browser();
                b.navigate(documentUrl, false, false);
            }
            else
            {
                error(strFmt("@ApplicationFoundation:DocuTemplateGenerationFailed", templateName));
            }
        }
        else
        {
            warning(strFmt("@ApplicationFoundation:DocuTemplateNotFound", templateName));
        }
    }

}

The following image shows the General ledgerGeneral ledger  > JournalsJournals  > General journalGeneral journal  form with the Open lines inOpen lines in

ExcelExcel  button highlighted.



To programmatically add generated and template Open in Excel options, Open in Excel options can be added by

implementing the ExportToExcelIGeneratedCustomExport and ExportToExcelITemplateCustomExport interfaces.

This allows the addition of options to forms where the entity or template doesn’t have the same table as the root

datasource. An example of when you would use this capability is on forms without a datasource, potentially

containing only a collection of form parts. The following example adds generated and template Open in Excel

options programmatically to the FMRentalFMRental  form.
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[Form]
public class FMRental extends FormRun implements ExportToExcelIGeneratedCustomExport, 
ExportToExcelITemplateCustomExport
{    
...

    public List getExportOptions()
    {
        List exportOptions = new List(Types::Class);

        ExportToExcelExportOption exportOption = 
ExportToExcelExportOption::construct(ExportToExcelExportType::CustomGenerated, int2str(1));
        exportOption.setDisplayNameWithDataEntity(tablestr(FMRentalEntity));
        exportOptions.addEnd(exportOption);

        ExportToExcelExportOption exportOption2 = 
ExportToExcelExportOption::construct(ExportToExcelExportType::CustomTemplate, int2str(2));
        exportOption2.displayName("Analyze rentals");
        exportOptions.addEnd(exportOption2);

        return exportOptions;
    }

    public ExportToExcelDataEntityContext getDataEntityContext(ExportToExcelExportOption _exportOption)
    {
        ExportToExcelDataEntityContext context = null;

        if (_exportOption.id() == int2str(1))
        {
            context = ExportToExcelDataEntityContext::construct(tablestr(FMRentalEntity), 
tablefieldgroupstr(FMRentalEntity, AutoReport));
        }

        return context;
    }

    public System.IO.Stream getTemplate(ExportToExcelExportOption _exportOption)
    {
        System.IO.Stream stream = null;

        if (_exportOption.id() == int2str(2))
        {
            stream = 
Microsoft.Dynamics.Ax.Xpp.MetadataSupport::GetResourceContentStream(resourcestr(FMRentalEditableExportTempla
te));
        }

        return stream;
    }

    public void updateTemplateSettings(ExportToExcelExportOption _exportOption, 
Microsoft.Dynamics.Platform.Integration.Office.ExportToExcelHelper.SettingsEditor _settingsEditor)
    {
    }
...

How do I add a filter for a programmatically-added template Open in
Excel option?
A template Open in Excel option can be programmatically added by implementing the

ExportToExcelITemplateCustomExport interface and providing a template in the getTemplate method. A filter for

that option can be programmatically added by using the ExportToExcelFilterBuilder API in the

updateTemplateSettings method.



public void updateTemplateSettings(ExportToExcelExportOption _exportOption, 
Microsoft.Dynamics.Platform.Integration.Office.ExportToExcelHelper.SettingsEditor _settingsEditor)

{

_settingsEditor.SetFilterExpression(tableStr(RetailTmpBulkProductAttributeValueEntity), 
element.getExportToExcelFilterExpression());

DictDataEntity dictDataEntity = new DictDataEntity(tableNum(RetailTmpBulkProductAttributeValueEntity));

_settingsEditor.SetFilterExpressionByPublicName(dictDataEntity.publicEntityName(), 
element.getExportToExcelFilterExpression());

}

How do I enable relationship lookups in Excel?

After a filter has been added programmatically, the resulting filter can be viewed in the Excel Add-in using the

FilterFilter  button. The following image shows the Excel Add-in with the FilterFilter  button highlighted.

The following image shows the Excel Add-in with the FilterFilter  dialog box opened.

To enable relationship lookups in the Excel Data Connector, you must ensure that the following metadata is set.

The Role and Related Data Entity Role defined on the relationship need to be unique among all
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How can I enable users to create new header records as well as lines
in a workbook?

relationships on both the source and target entity. Also, the relation role properties must be unique

across all entities. This is particularly important for relationships involving entities with many

relationships, such as DimensionCombinationEntity. If you're not seeing an expected lookup, try changing

the role names to the following format:

RoleRole: [this entity's public name] + [target entity's public name] + [target entity field] + "Source"

Related Data Entity RoleRelated Data Entity Role: [this entity's public name] + [target entity's public name] + [target

entity field] + "Target"

The Cardinality and Related Data Entity Cardinality need to be set appropriately.

At least one constraint must be added to the relationship. With the exception of dimension

relationships, which are a special case, the properties constrained must both be public.

To enable creation of header records and related lines, the header data source must be added as a set of "fields"

and the lines data source must be added as a related table. This pattern can work well for document data entry

scenarios such as Journal entry.

To learn more about header records and related lines, watch the short Create an Excel template for header and

line patterns in Dynamics 365 for Finance and Operations video.

To design a workbook with header fields and a lines table that enables header creation:

1. In the Excel Add-in, click DesignDesign to open the Designer. Select Add fieldsAdd fields  to add a header data source.

2. Select the header fields that you want to use. Be sure to include all the key fields or the NewNew  button won't be

enabled.

3. For all of the string header value fields, manually apply "Text" format for that cell using Excel r ibbon >Excel r ibbon >

Home tab > Number group > set "Number"Home tab > Number group > set "Number" in the format drop-down menu. If the Text format isn't

manually set on a string field and there's a string value with leading zeros like "00045", then Excel will

automatically change it to "45" and an error will be shown like: "Unable to change the value of

PurchaseOrderHeader's PurchaseOrderNumber field as it is a key field". Currently, the API doesn't allow for

automatically applying the text formatting on individual cells (versus table columns).

4. In the Designer, on the header data source, click the Add related tableAdd related table button represented by a double plus

icon.

5. Select the line fields that you want to use.

Here's an example of a header data source with a related table data source.

PurchaseOrderHeader (Fields)

PurchaseOrderLine (Table - related)

dataAreaId

PurchaseOrderNumber

PurchaseOrderName

OrderVendorAccountNumber

LineNumber

ItemNumber

LineDescription

OrderedPurchaseQuantity

LineAmount

https://youtu.be/RTicLb-6dbI


How can fields be added, removed, or moved within an existing
template workbook?

Troubleshooting

To use a header and lines workbook to create a new header and lines, follow these steps:

1. In the workbook, move the focus to a cell with a header value.

2. In the Excel Add-in, click NewNew .

3. Enter header values and lines as needed.

4. Select PublishPublish .

Fields can be added into an existing template workbook by editing the workbook stored in DocumentDocument

TemplatesTemplates .

1. Get the original template workbook.

2. Make changes to the template.

3. Upload the changed template.

4. Open the form that the template is used on and use the changed template.

a. Open the Document TemplatesDocument Templates  form.

b. Find the existing template workbook.

c. Download the workbook.

d. Open the workbook and enable editing so that the Excel Add-in runs.

a. In the Excel Add-in, select DesignDesign.

b. Click the EditEdit button (pencil icon) next to the datasource that you want to add a field into.

c. Add fields by moving them from the Available fieldsAvailable fields  list into the Selected fieldsSelected fields  list. Double-

clicking a field will move it. Remove fields by moving them from the Selected fieldsSelected fields  list into the

Available fieldsAvailable fields  list.Move fields using the UpUp and DownDown buttons.

d. After changes are complete, select UpdateUpdate, select YesYes  to confirm, and then select DoneDone to exit the

Designer (if appropriate, select RefreshRefresh to verify that the data is correctly populated).

e. Clear the data from the template before upload by clicking OptionsOptions  (gear icon), expand the DataData

ConnectorConnector  section, then click the Clear binding dataClear binding data button.

f. Use Save AsSave As  to store the template somewhere temporarily.

a. Return to the Document TemplatesDocument Templates  form and upload the changed template.

b. Click NewNew  and browse to find the changed template.

c. Select the saved template file and click OpenOpen.

d. In the Upload templateUpload template dialog box, remove the underscore and trailing random number from the

name For example, "CustInvoiceJournalTemplate_636564840743000567" becomes

"CustInvoiceJournalTemplate".

e. A confirmation dialog box should show that "A template with this name already exists...", click YesYes  to

confirm replacement of the previous template. Note that if this confirmation is not shown, then the

template name is different and it is being uploaded as a new template.

If you are not seeing an expected lookup, validate relationship metadata by checking the metadata feed available

at [YourSiteURL]/data/$metadata. Search the $metadat feed for the public name of your entity to find its

EntityType element, then make sure there is a child NavigationProperty element with a name equal to the Role

value of the relationship. If the navigation property exists, it will be used by the Excel Data Connector to show a

relationship lookup. Lookups are not shown under the following conditions:

All of the entity's key fields are included as constraints in the relationship.

The selected field is a key and the selected record is not new.



How do dimensions work?

How do I create formula table columns?

Known issues
Refresh doesn’t automatically occur in old templatesRefresh doesn’t automatically occur in old templates

Error finding entityError finding entity

The authenticated user does not have permission to access the entity targeted by the lookup.

The easiest way to set up dimension metadata on data entities is to use the data entity creation wizard, which

will automatically create the private relationships and public display value fields exactly as the dimensions

framework needs them. If you want to customize your dimensions setup, see Add dimensions to Excel

templates. Lookups, are only generated automatically for non-ledger dimensions. Custom dimensions are not

supported currently. If you want to enable lookups for ledger dimensions (MainAccount, Department,

CostCenter, etc.), see Add dimensions to Excel templates for guidance on creating relationships on

DimensionCombationEntity and DimensionSetEntity fields. When those relationships are present, relationship

lookups will be displayed in the Excel Data Connector. The Excel Data Connector supports two types of

dimension data entry: editing the display value directly or editing each attribute of the display value in a

separate column. If both the display value column and the individual attribute columns are bound, they can both

be edited and published separately. If both the display value and an individual attribute are edited in the same

row, the individual attribute change overrides the display value change.

If a formula is needed in a table, then add a formula column. When in the field selection page for a table binding,

click the FormulaFormula button above the Selected fields list to add a new formula column. The label and value for the

formula are entered in the fields immediately below the Selected fields list. After adding a new formula column,

leave the value empty and click UpdateUpdate. After the field has been added to the table, use standard Excel

capabilities to create a formula, then copy the formula and paste it into the formula column value field. When

defining a formula, make sure there is more than one row in the table, otherwise the formula that Excel provides

may be for ALL rows instead of THAT row. To specify just the current row, the at sign (@) is needed. For example,

sum of four columns for all rows "=SUM(Table1[[ColumnA]:[ColumnD]])" versus sum of four columns for the

current row "=SUM(Table1[@[ColumnA]:[ColumnD]])".

The ability to control “refresh on open” was added as a setting. To add this to the default behavior, existing

templates and workbooks need to have the Refresh on openRefresh on open check box selected in OptionsOptions  > DataData

ConnectorConnector  > Refresh OptionsRefresh Options .

The reference to entities changed from using the Private Entity Name (DataEntity.Name) to Public Entity Name

(DataEntity.PublicEntityName). If the public and private names for an entity were different and that entity was

used in an Excel template or workbook, then this will cause the following error to be displayed in the Excel App:

“Error Finding Entity. Details: Entity "<DataEntity.Name>" not found”.

To resolve this, change the binding information in the affected template so that it points to

DataEntity.PublicEntityName instead of DataEntity.Name.

1. For the DataEntity.Name that needs to be replaced, determine the DataEntity.PublicEntityName, for

example replace FMCustomerEntity with FleetCustomer.

2. Find the affected template.

3. Change the file extension on the template from .xlsx to .zip.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/financial/dimensions-overview
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4. The file to be changed will be one of the webextension*.xml files in the xlwebextensions directory, such as

2015-05-25-FleetCustomersWithLocations.zipxlwebextensionswebextension2.xml.

5. Open the file to ensure that you have the correct location.

6. Find the DataEntity.Name, such as FMCustomerEntity.

7. Extract the zip file.

8. Open the webextension xml file.

9. Replace the DataEntity.Name with the corresponding DataEntity.PublicEntityName.

10. Save the webextension .xml file changes.

11. Rename the old zip file, for example, add “.old” to the name.

12. Create a new zip file of all the previously extracted content. This usually involves highlighting the content

inside the archive/zip folder and creating a zipped folder using that content.

13. Verify that the zip file has the “_rels”, “docProps”, and “xl” folders in the root of the zip file.

14. Rename the zip file as needed, for example rename the file 2015-05-25-

FleetCustomersWithLocations.zip.

15. Change the zip file extension to .xlsx.

16. Re-publish the workbook .xlsx file, if needed.
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Add templates to the Open lines in Excel menu
2/18/2021 • 4 minutes to read • Edit Online

This topic describes how you can promote a template to the Open lines in the Excel menu that is available on

journal pages.

Some of the most frequently used templates are the journal templates. Some of these journal templates have

been promoted so that they appear on the Open lines in ExcelOpen lines in Excel  menu by default. However, when you add a

new template to the system, it's available on the Open in OfficeOpen in Office menu by default. To promote the template so

that it's available on the Open lines in ExcelOpen lines in Excel  menu, follow these steps.

using Microsoft.Dynamics.Platform.Integration.Office;  
public class TestNewTemplate extends DocuTemplateRegistrationBase implements 
LedgerIJournalExcelTemplate
{
    private const DocuTemplateName ExcelTemplateName = resourceStr(TestNewTemplate);
    private const EntityName LineEntityName = tableStr(LedgerJournalLineEntity);
    private const FieldName LineEntityJournalNum = fieldStr(LedgerJournalLineEntity, 
JournalBatchNumber);
    private const FieldName LineEntityDataAreaId = fieldStr(LedgerJournalLineEntity, dataAreaId);
    private const FieldName HeaderEntityName = tableStr(LedgerJournalHeaderEntity);
    private const FieldName HeaderEntityJournalNum = fieldStr(LedgerJournalHeaderEntity, 
JournalBatchNumber);
    private const FieldName HeaderEntityDataAreaId = fieldStr(LedgerJournalHeaderEntity, dataAreaId);
    /// <summary>

1. Create a Microsoft Excel template, and save it locally. For more information, see the "Create Open in Excel

experiences" article.

2. In Microsoft Visual Studio, create a new project for a model that has a reference to the ApplicationSuite

model.

3. Create a new class, implement the LedgerIJournalExcelTemplateLedgerIJournalExcelTemplate interface, and extend

DocuTemplateRegistrationBaseDocuTemplateRegistrationBase. Your implementation (supported journal type, and so on) defines the

context that your template will be available as an option for in the Open in Excel experience. This example

uses LedgerJournalHeaderEntity and LedgerJournalLineEntity, but you aren't limited to these entities. You

can define your own entities, provided that they entities follow the journal header/line entity pattern.

Here is an example from the LedgerDailyJournalExcelTemplateLedgerDailyJournalExcelTemplate class.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/user-interface/add-templates-open-lines-excel-menu.md
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    /// A boolean value which indicates whether the journal type is supported for the Excel template.
    /// </summary>
    /// <param name = "_ledgerJournalType">The ledger journal type.</param>
    /// <returns>True if the journal type is supported; otherwise, false.</returns>
    public boolean isJournalTypeSupported(LedgerJournalType _ledgerJournalType)
    {
        return _ledgerJournalType == LedgerJournalType::Daily;
    }
    /// <summary>
    /// Gets the document template name.
    /// </summary>
    /// <returns>The document template name</returns>
    public DocuTemplateName documentTemplateName()
    {
        return ExcelTemplateName;
    }
    /// <summary>
    /// Gets a collection of the supported account types for the entity.
    /// </summary>
    /// <returns>A collection of <c>LedgerJournalACType</c> values.</returns>
    public Set supportedAccountTypes()
    {
        Set accountTypeSet = new Set(Types::Integer);
        accountTypeSet.add(LedgerJournalACType::Ledger);
        return accountTypeSet;
    }
    /// <summary>
    /// Gets a collection of the supported offset account types for the entity.
    /// </summary>
    /// <returns>A collection of <c>LedgerJournalACType</c> values.</returns>
    public Set supportedOffsetAccountTypes()
    {
        Set offsetAccountTypeSet = new Set(Types::Integer);
        offsetAccountTypeSet.add(LedgerJournalACType::Ledger);
        return offsetAccountTypeSet;
    }
    /// <summary>
    /// Validates the journal is valid for the template.
    /// </summary>
    /// <param name = "_ledgerJournalTable">The <c>LedgerJournalTable</c> record.</param>
    /// <returns>True if the journal is valid for the template; otherwise, false.</returns>
    public boolean validateJournalForTemplate(LedgerJournalTable _ledgerJournalTable)
    {
        return LedgerJournalExcelTemplate::validateJournalForTemplate(_ledgerJournalTable, this);
    }
    public void registerTemplates()
    {
        this.addTemplate(
            OfficeAppApplicationType::Excel,
            ExcelTemplateName,
            ExcelTemplateName,
            'Test new template',
            'Test new template',
            NoYes::No,
            NoYes::No,
            NoYes::No);
    }
    /// <summary>
    /// The resource name of the header entity.
    /// </summary>
    /// <returns>The resource name of the header entity.</returns>
    public EntityName headerEntityName()
    {
        return HeaderEntityName;
    }
    /// <summary>
    /// The resource name of the line entity.
    /// </summary>
    /// <returns>The resource name of the line entity.</returns>



    /// <returns>The resource name of the line entity.</returns>
    public EntityName lineEntityName()
    {
        return LineEntityName;
    }
    /// <summary>
    /// The field name for the header journal batch number.
    /// </summary>
    /// <returns>The field name for the header journal batch number.</returns>
    public FieldName headerJournalBatchNumberFieldName()
    {
        return HeaderEntityJournalNum;
    }
    /// <summary>
    /// The field name for the header data area.
    /// </summary>
    /// <returns>The field name for the header data area.</returns>
    public FieldName headerDataAreaFieldName()
    {
        return HeaderEntityDataAreaId;
    }
    /// <summary>
    /// The field name for the line journal batch number.
    /// </summary>
    /// <returns>The field name for the line journal batch number.</returns>
    public FieldName lineJournalBatchNumberFieldName()
    {
        return LineEntityJournalNum;
    }
    /// <summary>
    /// The field name for the line data area.
    /// </summary>
    /// <returns>The field name for the line data area.</returns>
    public FieldName lineDataAreaFieldName()
    {
        return LineEntityDataAreaId;
    }
    /// <summary>
    /// Append additional filter to the default filtering behavior.
    /// </summary>
    /// <returns>The original filter with new filter(s) appended; Otherwise, the original 
filter</returns>
    public FilterCollectionNode appendHeaderEntityFilters(FilterCollectionNode _headerFilter, 
ExportToExcelFilterTreeBuilder _headerFilterBuilder)
    {
        return _headerFilter;
    }
    /// <summary>
    /// Append additional filter to the default filtering behavior.
    /// </summary>
    /// <returns>The original filter with new filter(s) appended; Otherwise, the original 
filter</returns>
    public FilterCollectionNode appendLineEntityFilters(FilterCollectionNode _lineFilter, 
ExportToExcelFilterTreeBuilder _lineFilterBuilder)
    {
        FilterCollectionNode lineFilter = _lineFilterBuilder.and(
            _lineFilterBuilder.areEqual(fieldStr(LedgerJournalLineEntity, AccountType), 
LedgerJournalACType::Ledger),
            _lineFilterBuilder.areEqual(fieldStr(LedgerJournalLineEntity, OffsetAccountType), 
LedgerJournalACType::Ledger));
        return _lineFilterBuilder.and(_lineFilter, lineFilter);
    }
}

4. Build the project/model that has the new resources. You should have one new resource and one new

class.



Additional resources

NOTENOTE

5. In the client, go to CommonCommon > CommonCommon > Office integrationOffice integration > Document templatesDocument templates  > ReloadReload

system templatessystem templates . You will see the new template in the list, and if you open the journal page that you

added the template to, you will also see that template on the Open lines in ExcelOpen lines in Excel  menu.

Create Open in Excel experiences

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/user-interface/media/22.png
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Customize the Open in Microsoft Office menu
2/18/2021 • 10 minutes to read • Edit Online

Overview

M EN U IT EMM EN U IT EM DESC RIP T IO NDESC RIP T IO N

Export to Excel The data is exported to an Excel workbook. The workbook
contains no references back to Finance and Operations, and
the data can't be refreshed.

Export to Word The data is exported to a Word document. The document
contains no references back to Finance and Operations, and
the data can't be refreshed.

Open in Excel A workbook is created that contains the Microsoft Dynamics
Office add-in. The workbook contains a reference back to
Finance and Operations, and the data can be refreshed,
updated, and published from the Data Connector that is
hosted in the add-in.

How menu items are added to the Open in Office menu

Default exports

Applies to these Dynamics 365 appsApplies to these Dynamics 365 apps :

Commerce, Finance, Supply Chain Management

Most pages include an Open in Microsoft Office menu. This topics provides information about the Open in

Office menu, and explains how customize it by adding, removing, and changing options.

The Open in Microsoft OfficeOpen in Microsoft Office menu button (Open in OfficeOpen in Office menu) is a system-defined button that appears

on pages. The Open in OfficeOpen in Office menu contains menu items that let you export data to various Office products,

such as Microsoft Excel and Microsoft Word. The following table describes the menu items on the Open inOpen in

OfficeOffice menu.

The export options are added to the Open in OfficeOpen in Office menu in the following manner :

1. In the Expor t to ExcelExpor t to Excel  group, a menu item is added for each visible grid.

2. For each root data source on the page, the set of data entities that have the same root data source is

determined. For each of these data entities, the following menu items are added:

In the Open in ExcelOpen in Excel  group, a menu item is added for a default export of the data entity.

In the Open in ExcelOpen in Excel  group, a menu item is added for each Document Template record of the ExcelExcel

type that has the same root data entity and is marked for inclusion on the Open in OfficeOpen in Office menu.

In the Expor t to WordExpor t to Word group, a menu item is added for each Document Template record of the

WordWord type that has the same root data entity and is marked for inclusion on the Open in OfficeOpen in Office

menu.

The Open in OfficeOpen in Office menu provides a default export for each data entity. This export includes all the fields in the

AutoRepor tAutoRepor t group on the data entity. If SaveDataPerCompanySaveDataPerCompany  is set to YesYes  for the data entity, a filter is

applied to limit the data to the current company.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/office-integration/customize-open-office-menu.md


Document templates
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Root data entity The root data entity of the template. The root data entity is
used to determine which pages the template can be included
on.

List in Office menu If this field is selected, the template will be included on the
Open in OfficeOpen in Office menu on applicable pages. (The applicable
pages depend on the root data entity).

Apply record filter If this field is selected, the data will be filtered, based on the
record that is currently selected on the page.

Apply company filter If this field is selected, the data will be filtered, based on the
current company.

Trimmed template columns and fieldsTrimmed template columns and fields

Open in Office menu customization

Modifying the Open in Office menu through interfacesModifying the Open in Office menu through interfaces

IN T ERFA C EIN T ERFA C E DESC RIP T IO NDESC RIP T IO N

OfficeIMenuCustomizer Use this interface to modify the set of data entities that is
considered for a page and add custom menu items.

OfficeIGeneratedWorkbookCustomExporter Use this interface to do a custom export of a workbook that
is generated at run time.

OfficeITemplateCustomExporter Use this interface to do a custom export that is based on a
Document Template record.

Modifying the Open in Office menu through extensions and event subscriptionsModifying the Open in Office menu through extensions and event subscriptions

Document templates can be added from the Document templatesDocument templates  page. Several fields that are associated with

each Document Template record control the behavior of that template on the Open in OfficeOpen in Office menu.

For Excel templates that are included on the Open in OfficeOpen in Office menu, columns and fields will be trimmed from

the workbook, based on the configuration keys that are applied to the system and the applicable country/region

context. If a configuration key is associated with a column or field in the workbook, the column or field will be

removed if the configuration key is disabled. If a set of country/region codes is associated with the column or

field in the workbook, the column or field will be removed if the country/region code isn't in scope.

There are several methods for customizing the content that appears on the Open in OfficeOpen in Office menu on a given

page. For example, you can customize the content statically through metadata properties on model element and

code attributes. However, customization via code gives you the finest level of control. In code, you can either

implement one or more interfaces on a page, or use extensions and event subscriptions. The following sections

describe the customization scenarios that are most often used.

If you must modify a page that you own, interfaces are the most appropriate customization method, because

they give access to all private members of the page and allow for deeper customization. You can apply the

following interfaces to the code for a page.

If you must modify a page that you don't own, you should avoid using interfaces, because that approach will



public static class MyForm_Extension
{
    [FormEventHandler(formStr(MyForm), FormEventType::Initializing)]
    public static void ExportToExcel_DataEntityCustom_OnInitializing(xFormRun sender, FormEventArgs e)
    {
        FormRun formRun = sender as FormRun;
        if (formRun)
        {
            OfficeFormRunHelper officeHelper = formRun.officeHelper();
            if (officeHelper)
            {
                officeHelper.OfficeMenuInitializing += 
eventhandler(MyForm_Extension::officeMenuInitializingHandler);
            }
        }
    }
    private static void officeMenuInitializingHandler(FormRun _formRun, OfficeMenuEventArgs _eventArgs)
    {
        // Modify the OfficeMenuOptions available on the OfficeMenuEventArgs.menuOptions() as necessary.
    }
}

Typical customization scenarios

Modifying the set of data entities that is considered for a pageModifying the set of data entities that is considered for a page

// Add an entity to the list
OfficeMenuDataEntityOptions entityOptions  = OfficeMenuDataEntityOptions::construct(tableStr(MyEntity));
_menuOptions.dataEntityOptions().addEnd(entityOptions);
// Remove an entity from the list
ListIterator dataEntityOptionsIterator = new ListIterator(_menuOptions.dataEntityOptions());
while (dataEntityOptionsIterator.more())
{
    OfficeMenuDataEntityOptions dataEntityOptions = dataEntityOptionsIterator.value();
    if (dataEntityOptions.dataEntityName() == tableStr(MyOtherEntity))
    {
        dataEntityOptionsIterator.delete();
    }
    else
    {
        dataEntityOptionsIterator.next();
    }
}

Specifying the default data entity–related options that are includedSpecifying the default data entity–related options that are included

require over-layering. Instead, you should do the customization through extensions and event subscriptions. To

use this approach, implement an extension class that subscribes to the OnIntializingOnIntializing event of the page that

you're customizing. From this event handler, get the OfficeFormRunHelperOfficeFormRunHelper  for the page, and subscribe to its

OfficeMenuInitializingOfficeMenuInitializing event. The following example shows sample code for this approach.

The following examples assume that the _menuOptions_menuOptions  variable contains the OfficeMenuOptionsOfficeMenuOptions  instance

that you're customizing.

Many of the menu items on the Open in OfficeOpen in Office menu are added automatically, based on the data entities that

are considered for the page. However, in some cases, the algorithm that is used to determine the set of data

entities might not determine the correct set. To modify the set of data entities that is considered for the page,

you can use the OfficeMenuOptionsOfficeMenuOptions  that is available from either the

OfficeIMenuCustomizer.customizeMenuOptionsOfficeIMenuCustomizer.customizeMenuOptions  method or the

OfficeFormRunHelper.OfficeMenuInitializingOfficeFormRunHelper.OfficeMenuInitializing delegate.



// Find the entity options if they were included by default.
OfficeMenuDataEntityOptions entityOptions = _menuOptions.getOptionsForEntity(tableStr(MyEntity));
if (!entityOptions)
{
    // The entity options were not included. Add them.
    entityOptions = OfficeMenuDataEntityOptions::construct(tableStr(MyEntity);
    _menuOptions.dataEntityOptions().addEnd(entityOptions);
}
entityOptions.includeDefault(false); // Don't include the default export menu item.
entityOptions.includeTemplates(false); // Don’t include Document Template related menu items.

Adding a custom export menu item – Generating a workbookAdding a custom export menu item – Generating a workbook

OfficeGeneratedExportMenuItem menuItem = OfficeGeneratedExportMenuItem::construct(tableStr(MyEntity), 
"MyCustomGeneratedExportId");
menuItem.setDisplayNameWithDataEntity();
_menuOptions.customMenuItems().addEnd(menuItem);

Using interfacesUsing interfaces

public ExportToExcelDataEntityContext getDataEntityContext(OfficeGeneratedExportMenuItem _menuItem)
{
    ExportToExcelDataEntityContext context = null;
    if (_menuItem.id() == "MyCustomGeneratedExportId")
    {
        context = ExportToExcelDataEntityContext::construct(tableStr(MyEntity), tableFieldGroupStr(MyEntity, 
MyFieldGroup);
    }
    return context;
}

Using extensions and event subscriptionsUsing extensions and event subscriptions

menuItem.getDataEntityContext += eventhandler(MyForm_Extension::getDataEntityContextHandler);

Adding a custom export menu item – Specifying a document templateAdding a custom export menu item – Specifying a document template

The OfficeMenuDataEntityOptionsOfficeMenuDataEntityOptions  class lets you specify whether to include a menu item for a default export

or a menu item that is related to a document template.

To explicitly add a menu item, you must add it to the OfficeMenuOptions.customMenuItems()OfficeMenuOptions.customMenuItems()  list. To add a

menu item that corresponds to a workbook that is generated at run time, use an

OfficeGeneratedExpor tMenuItemOfficeGeneratedExpor tMenuItem.

To define what is actually exported, use an Expor tToExcelDataEntityContextExpor tToExcelDataEntityContext. The method for specifying the

Expor tToExcelDataEntityContextExpor tToExcelDataEntityContext depends on whether you're using interfaces or extensions and event

subscriptions to customize the Open in OfficeOpen in Office menu.

If you're using interfaces, you must implement the

OfficeIGeneratedWorkbookCustomExpor ter.getDataEntityContext()OfficeIGeneratedWorkbookCustomExpor ter.getDataEntityContext()  method.

If you're using extensions and event subscriptions, the

OfficeGeneratedExpor tMenuItem.getDataEntityContextOfficeGeneratedExpor tMenuItem.getDataEntityContext delegate should be subscribed to before you add

the menu item to the OfficeMenuOptions.customMenuItems()OfficeMenuOptions.customMenuItems()  list. The code for the event handler should

resemble the preceding code for the interface. The following example shows how to do the event subscription.

To explicitly add a menu item, you must add it to the OfficeMenuOptions.customMenuItems()OfficeMenuOptions.customMenuItems()  list. To add a

menu item that corresponds to a Document Template record, use an OfficeTemplateExpor tMenuItemOfficeTemplateExpor tMenuItem.



OfficeTemplateExportMenuItem menuItem = 
OfficeTemplateExportMenuItem::construct(OfficeAppApplicationType::Excel, "MyTemplateId", 
"MyCustomTemplateExportId");
_menuOptions.customMenuItems().addEnd(menuItem);

Using interfacesUsing interfaces

public Map getInitialTemplateFilters(OfficeTemplateExportMenuItem _menuItem)
{
    Map initialFilters = new Map(Types::String, Types::Class);
 if (_menuItem.id() == "MyCustomTemplateExportId")
 {
  // Add an initial filter.
  ExportToExcelFilterTreeBuilder bldr = new ExportToExcelFilterTreeBuilder(_menuItem.dataEntityName());
  FilterNode filter = // create the filter…
  initialFilters.insert(_menuItem.dataEntityName(), filter);
 }
 return initialFilters;
}
public void updateTemplateSettings(OfficeTemplateExportMenuItem _menuItem, 
Microsoft.Dynamics.Platform.Integration.Office.SettingsManager _settingsManager)
{
 if (_menuItem.id() == "MyCustomTemplateExportId")
 {
  // Set a new filter.
  ExportToExcelFilterTreeBuilder bldr = new ExportToExcelFilterTreeBuilder(_menuItem.dataEntityName());
  FilterNode filter = // create the filter…
  Excel.WorkbookSettingsManager workbookSettingsManager = _settingsManager as Excel.WorkbookSettingsManager;
  workbookSettingsManager.SetEntityFilter(entityMetadata.PublicEntityName, filter);
  // Adjust settings.
  DataConnectorAppletSettings settings = settingsManager.DataConnectorSettings;
  DataConnectorAppletUserOptions options = settings.DataOptions;
  options.RefreshOnOpen = true;
  options.EnableDesign = false;
  workbookSettingsManager.DataConnectorSettings = settings;
 }
}

Using extensions and event subscriptionsUsing extensions and event subscriptions

menuItem.getInitialTemplateFilters += eventhandler(MyForm_Extension::getInitialTemplateFiltersHander);
menuItem.updateTemplateSettings += eventhandler(MyForm_Extension::updateTemplateSettingsHandler);

Additional customizations

To modify the template at run time, you can supply a set of initial filters. These filters will replace any filters in

the template for the specified data entities. Additionally, you can modify filters and specify many settings by

using WorkbookSettingsManagerWorkbookSettingsManager . The following sections show examples.

If you're using interfaces, you must implement the

OfficeITemplateCustomExpor ter.getInitialTemplateFilters()OfficeITemplateCustomExpor ter.getInitialTemplateFilters()  and

OfficeITemplateCustomExpor ter.updateTemplateSettings()OfficeITemplateCustomExpor ter.updateTemplateSettings()  methods.

If you're using extensions and event subscriptions, the

OfficeTemplateExpor tMenuItem.getInitialTemplateFiltersOfficeTemplateExpor tMenuItem.getInitialTemplateFilters  and

OfficeTemplateExpor tMenuItem.updateTemplateSettingsOfficeTemplateExpor tMenuItem.updateTemplateSettings  delegates should be subscribed to before you

add the menu item to the OfficeMenuOptions.customMenuItems()OfficeMenuOptions.customMenuItems()  list. The code for the event handlers

should resemble the preceding code for the interface. The following example shows how to do the event

subscription.

The following customizations let you modify the contents of the Open in OfficeOpen in Office menu for a page without using



Removing an Export to Excel menu item for a gridRemoving an Export to Excel menu item for a grid

Renaming an Export to Excel menu item for a gridRenaming an Export to Excel menu item for a grid

Removing all menu items for a data entity from all pagesRemoving all menu items for a data entity from all pages

[OfficeMenuOmit]
public class MyEntity extends common
{
 // Entity code…
}

Adding a menu item button to a page that corresponds to an Open in Office menu entryAdding a menu item button to a page that corresponds to an Open in Office menu entry

NOTENOTE

interfaces or extensions and event handlers.

On the Open in OfficeOpen in Office menu, the Expor t to ExcelExpor t to Excel  group will contain a menu item for each visible grid. To

remove a grid from the Open in OfficeOpen in Office menu, set the Expor tAllowedExpor tAllowed metadata property on the grid to NoNo.

After you make this change, users won't be able to export the grid by using the shortcut menu for the grid.

To rename the Expor t to ExcelExpor t to Excel  menu item that is related to a grid, set the Expor tLabelExpor tLabel  metadata property on

the grid to the appropriate label.

Integration scenarios require that some data entities be publicly available via the OData Service. However, it isn't

always appropriate that these data entities appear on the Open in OfficeOpen in Office menu by default. In this scenario, you

can add the OfficeMenuOmitOfficeMenuOmit code attribute to the entity declaration.

After you make this change, by default, the entity won't appear on the Open in OfficeOpen in Office menu on pages that

have a matching root data source. However, if the entity should be added to a specific page, you can use other

customization mechanisms to add it.

Sometimes, it's appropriate that the Action Pane of a page have a menu item button that corresponds to a

custom menu item on the Open in OfficeOpen in Office menu. In this case, you can model a menu item button that has the

following properties:

Menu Item Type:Menu Item Type: ActionAction

Menu Item Name:Menu Item Name: Expor tToExcelExpor tFormExpor tToExcelExpor tForm

Parameters:Parameters: The ID of the menu item

Then, a mouse click of this menu item button is equivalent to a mouse click of the corresponding menu item on

the Open in OfficeOpen in Office menu.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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[Administrator] Email parameters page
Configuration tabConfiguration tab

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Batch email provider Specifies which email provider will be used to send emails
that are sent by processes in a batch or non-interactive
manner. The Exchange provider will use the account
associated with the batch process.

Attachment size limit Specifies the maximum size of a single email that can be sent
via the email subsystem.

SMTP settings tabSMTP settings tab

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Outgoing mail server The host name of the desired SMTP server.

SMTP port number Typically, the port number should be set to 587 for secure
transport.

The behavior of the email subsystem is influenced by a combination of administrator configuration, user

configuration, and user choices. This topic is divided into sections for administrators and users to make it easy to

find relevant information.

Both administrators and users set the behavior of the email subsystem.

On the Email parametersEmail parameters  page, note the following settings on the ConfigurationConfiguration tab.

In Platform update 32, an Email histor yEmail histor y  page was added to allow administrators to review all sent emails,

including any errors that might have prevented an email from being sent. By default, the last 30 days of email

history is retained. This can be configured by changing the Number of days to retain email histor yNumber of days to retain email histor y  to a

non-zero amount. Zero provides the default amount and behavior.

In version 10.0.16/Platform 40, an Email throttlingEmail throttling section is visible, if your environment has enabled the

Email throttlingEmail throttling feature in Feature management. This feature allows non-interactive email providers (such as

the batch email provider) to adhere to a per-minute sending limit. This can prevent errors from the system

attempting to send more emails than the provider allows. The sending limits for Microsoft 365 email providers

are set automatically according to Exchange Online sending limits. Manual configuration is required for all other

email providers. The per-minute sending limit can be removed from a provider by resetting the per-minuteper-minute

email sending limitemail sending limit field to 0.

On the Email parametersEmail parameters  page, note the following settings on the SMTP settingsSMTP settings  tab.

For Microsoft 365 production (including
*.onmicrosoft.com accounts) use smtp.office365.com.
(You can find this setting at outlook.office.com at
SettingsSettings > MailMail > POP and IMAPPOP and IMAP.)

For Outlook/Hotmail use smtp-mail.outlook.com.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/configure-email.md
https://docs.microsoft.com/en-us/office365/servicedescriptions/exchange-online-service-description/exchange-online-limits?sending-limits#sending-limits
https://support.office.com/article/Outlook-settings-for-POP-and-IMAP-access-for-Office-365-for-business-or-Microsoft-Exchange-accounts-7fc677eb-2491-4cbc-8153-8e7113525f6c


User nameUser name and PasswordPassword Specify, as needed, to send the email via the appropriate mail
account. All users need to provide the SMTP account SendSend
AsAs and Send On Behalf OfSend On Behalf Of permissions to enable the
ability to send Simple Mail Transfer Protocol (SMTP) mail. You
can configure Send As permissions in the Microsoft 365
admin center (portal.office.com/Admin), at UsersUsers  > ActiveActive
usersusers  > UserUser  > Edit mailbox permissionsEdit mailbox permissions > SendSend
email from this mailboxemail from this mailbox. For more information, see
Enable sending email from another user's mailbox in
Microsoft 365.

Specify if SSL is required Determines whether secure transport is used. Typically, this
is YesYes , except for internal or troubleshooting scenarios.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

[Administrator] Email distributor batch process

[Administrator] User email

[User] Email provider selection section on the Options page

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Email provider ID Allows the user to select the email provider that should be
used when sending an email. Selecting an option here is the
equivalent of selecting Do not ask againDo not ask again in the HowHow
would you like to send emailwould you like to send email dialog box. Selecting the
blank option Prompt for which email provider to usePrompt for which email provider to use
will cause the How would you like to send emailHow would you like to send email dialog
box to display when an email is going to be sent.

Email that is sent directly from the server, without user interaction, via SMTP is sent by the Email distr ibutorEmail distr ibutor

batchbatch process. That batch process must be started to process the email queue. To start the process, open the

Email distr ibutor batchEmail distr ibutor batch pane (System administrationSystem administration > Periodic tasksPeriodic tasks  > Email processingEmail processing > BatchBatch)

and turn on Batch processingBatch processing.

If the Exchange provider is used, then the user account associated with the batch process (usually admin) will be

sender.

The default send fromsend from address for each user is pulled from the EmailEmail  field on the UsersUsers  page (SystemSystem

administrationadministration > UsersUsers  > UsersUsers ). Administrators can override this send fromsend from default if needed using the

Sender emailSender email  field on the OptionsOptions  page.

The OptionsOptions  page can be opened via Settings > User optionsSettings > User options . The Email provider selectionEmail provider selection section is on

the AccountAccount tab.

https://support.office.com/article/Enable-sending-email-from-another-user-s-mailbox-in-Office-365-2B828C5F-41AB-4904-97B9-3B63D8129C4E


Sender email Allows the administrator to provide an email address
override for the user in the FromFrom field of the email. By
default, the email alias that is associated with the user
account is used as the FromFrom field in new emails, but this
user option email address will override that. When sending
email via SMTP, the user needs to have appropriate Send AsSend As
and Send On Behalf OfSend On Behalf Of permissions configured in
Exchange or on the SMTP server.

[!NOTE] You can configure Send AsSend As and Send OnSend On
Behalf OfBehalf Of permissions in the Microsoft 365 admin
center (portal.office.com/Admin) at UsersUsers  > ActiveActive
usersusers  > UserUser  > Edit mailbox permissionsEdit mailbox permissions > SendSend
email from this mailboxemail from this mailbox. For more information, see
Enable sending email from another user's mailbox in
Microsoft 365.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

[User] How would you like to send email dialog box (optional)

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Use an email app, such as Outlook Provides the user with a generated email (.eml) file.

Use Exchange email server Uses the Exchange Online server associated with the tenant.
On-premises Exchange servers are currently not supported
for the ExchangeExchange mail provider.

Use the system email client Opens the Send emailSend email composition dialog box and then
sends the resulting email via SMTP.

Do not ask again If this field is not selected, the next time an email is sent the
most recently selected option will be used and the dialog
box will not open.

[User] Send email dialog box (optional)

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

From Populated from the EmailEmail field on the OptionsOptions page.

ToTo, CcCc, BccBcc, SubjectSubject , and BodyBody Populated with values specified by the process that initiated
the sending of the email. These fields can be edited as
needed by the user.

Attachments list May be populated with attachments specified by the process
that initiated the sending of the email. This list can be edited
as needed by the user.

When an email is going to be sent, the user will see the How would you like to send emailHow would you like to send email  dialog box that

will list the available options for sending email.

The Send emailSend email  dialog box is opened to allow the user to edit the contents of the email that will be sent. Some

of the following fields will be pre-populated in this window.

https://support.office.com/article/Enable-sending-email-from-another-user-s-mailbox-in-Office-365-2B828C5F-41AB-4904-97B9-3B63D8129C4E


Usage scenarios to verify if email is configured correctly
Send mail via a local mail clientSend mail via a local mail client

Send mail via SMTPSend mail via SMTP

When the email is ready to be sent, the SendSend button will cause the email to be sent via SMTP.

Email workflows that are enabled via the SysEmail framework can generate email messages (.eml files) that

contain attachments. You can then send these messages via Microsoft Outlook or another email client.

1. In Internet Explorer, navigate to Accounts receivableAccounts receivable > CustomersCustomers  > All customersAll customers .

2. Select US-008 Sparrow RetailUS-008 Sparrow Retail .

3. Click CollectCollect > Customer balancesCustomer balances  > CollectionsCollections  to open the CollectionsCollections  page.

4. Click CommunicateCommunicate > EmailEmail  > Statements to contactStatements to contact.

5. Click OKOK to accept the default values in the dialog box.

6. If you're prompted for the mail option to use, clear the Do not ask againDo not ask again check box (you can change this

option from the User optionsUser options  page), select Use an email app, such as OutlookUse an email app, such as Outlook, and then click OKOK.

7. If you're using Internet Explorer on your computer, open the email (.eml) file that is generated. If you're using

Internet Explorer on the VM, copy the file to your computer, and open it there.

8. Note the email address in the ToTo field and the generated workbook attachment.

Email workflows that are enabled via the SysEmail framework can also be created in a simple email dialog box

and then sent via Simple Mail Transfer Protocol (SMTP).

1. Go to the Email parametersEmail parameters  page.

2. Click SMTP settingsSMTP settings .

3. Set the Outgoing mail ser verOutgoing mail ser ver  to the desired SMTP server :

For Microsoft 365 production (including *.onmicrosoft.com accounts) use smtp.office365.com. (Find

this setting via outlook.office.com, at SettingsSettings  > MailMail  > POP and IMAPPOP and IMAP.)

For Outlook/Hotmail use smtp-mail.outlook.com.

4. Set the user name and password to an appropriate email account and password.

5. Leave SSLRequiredSSLRequired turned on, and leave SMTP por t numberSMTP por t number  set to 587587 .

6. Click SaveSave.

7. In Internet Explorer, navigate to Accounts receivableAccounts receivable > CustomersCustomers  > All customersAll customers .

8. Select US-008 Sparrow RetailUS-008 Sparrow Retail .

9. Click CollectCollect > Customer balancesCustomer balances  > CollectionsCollections  to open the CollectionsCollections  page.

10. Click CommunicateCommunicate > EmailEmail  > Statements to contactStatements to contact.

11. Click OKOK to accept the default values in the dialog box.

12. If you're prompted for the mail option to use, select Use the Microsoft Dynamics 365 for FinanceUse the Microsoft Dynamics 365 for Finance

and Operations email clientand Operations email client, and then click OKOK.

13. To receive the test message, change the To addressTo address  to your email address.

Ensure that the account specified in the SMTP settings is able to Send AsSend As  and Send On Behalf OfSend On Behalf Of your

email account. The easiest way to ensure this to use your email account in the SMTP settings.

14. Enter a subject and body for the message.

https://support.office.com/article/Outlook-settings-for-POP-and-IMAP-access-for-Office-365-for-business-or-Microsoft-Exchange-accounts-7fc677eb-2491-4cbc-8153-8e7113525f6c


[Administrator] Workflow email notifications

Workflow email notification setupWorkflow email notification setup

15. Click SendSend. The message should be delivered in one to five minutes.

Workflow email configuration is a collection of related settings that work in conjunction.

1. Verify email settings:

a. Go to System administrationSystem administration > SetupSetup > EmailEmail  > Email parametersEmail parameters .

b. Verify that SMTP is enabled.

c. Set the SMTP mail server settings.

2. Verify that the email batch process is running:

a. Go to System administrationSystem administration > Periodic tasksPeriodic tasks  > Email processingEmail processing > Email distr ibutorEmail distr ibutor

batchbatch.

b. Enable the Batch processingBatch processing option.

c. Optionally, adjust the recurrence of the email process:

a. Select No end dateNo end date to adjust all recurrences of the email batch process.

b. Adjust the count.

c. Adjust to run every minute if needed.

3. Verify workflow notification system email templates:

a. Go to System administrationSystem administration > SetupSetup > EmailEmail  > System email templatesSystem email templates  (for system-wide

templates).

b. Verify that the Sender emailSender email  field is set and valid.

4. Verify workflow notification organization email templates:

a. Go to Organization administrationOrganization administration > SetupSetup > Organization email templatesOrganization email templates  (for organization-

specific templates).

b. Verify that the Sender emailSender email  field is set and valid.

5. Verify that the user can receive email notifications:

a. Go to SettingsSettings  > User optionsUser options .

b. Go to the AccountAccount tab.

a. Set the Email provider IDEmail provider ID (for example, SMTP).

b. Optionally, set a Sender emailSender email  override if the default send fromsend from address should not be used

for the current user.

c. Navigate to the WorkflowWorkflow  tab. Set the option to send notifications in email to YesYes .

6. Verify that the workflow system will send email notifications:

For each workflow that should have a notification, open the workflow properties in the workflow editor.

a. Click Basic settingsBasic settings . Adjust the email template for the workflow notifications.

b. Click NotificationsNotifications .

a. Enable the events for which a user should be notified.

b. Set the recipient of the workflow notification for each event notification that is enabled.

c. On a workflow approval element for which a user should be notified:



Workflow email notification testingWorkflow email notification testing

Troubleshoot email

a. Go to Proper tiesProper ties .

b. Enable the events for which a user should be notified.

c. Set the recipient of the workflow notification for each event notification that is enabled.

The testing for email notifications is to simply trigger the notification and then check for it.

1. Submit a workflow that has been set up for email notifications.

2. Check the workflow history to make sure that a workflow work item was assigned to the expected user.

3. Check the status of the pending email notification in System administrationSystem administration > Periodic tasksPeriodic tasks  >

Email processingEmail processing > Batch email sending statusBatch email sending status .

If the email is fails to send, make sure that the SMTP mail account can be opened.

4. Check for the email notification in the appropriate inbox.

There are a few standard steps that can help you troubleshoot the configuration of email settings.

1. Verify email settings:

a. Go to System administrationSystem administration > SetupSetup > EmailEmail  > Email parametersEmail parameters .

b. Verify that SMTP is enabled.

c. Verify the settings of the SMTP mail server.

d. Sign in to the SMTP account in a separate window to make sure that the account and password are

correct.

e. Send a test email using System administrationSystem administration > SetupSetup > EmailEmail  > Email parametersEmail parameters  > TestTest

emailemail .

2. Verify that the email batch process is running:

a. Go to System administrationSystem administration > Periodic tasksPeriodic tasks  > Email processingEmail processing > BatchBatch.

b. Make sure that the Batch processingBatch processing option is set to YesYes .

c. Review the recurrence of the email process:

a. Select No end dateNo end date to adjust all recurrences of the email batch process.

b. Adjust the count as you require.

3. To review the contents and status of batch emails, go to System administrationSystem administration > Periodic tasksPeriodic tasks  >

Email processingEmail processing > Batch email sending statusBatch email sending status .

a. If you're using a release that is earlier than Platform update 28, personalize the form to add the email

sender for easy review. To do this, right-click the grid header, select Add columnsAdd columns , select EmailEmail , and

then click Inser tInser t. If the EmailEmail  field isn't added into the grid, you can view the sender by selecting

Show messageShow message, and then selecting the EmailEmail  field.

b. Verify that emails are being sent from the correct account. If the account is incorrect, you need to

adjust settings such as user options, system templates, or organization templates, as needed.

c. Verify that all email user accounts have been granted permission to Send AsSend As  for the configured SMTP

account (see step 4 for details).

4. In Platform update 32, an Email histor yEmail histor y  page was added to allow administrators to review all sent

emails, including any errors that might have prevented an email from being sent. The Email histor yEmail histor y

page will show interactive as well as non-interactive/batch emails. For any emails that have an EmailEmail

statusstatus  of FailedFailed, review the error message on the Failure detailsFailure details  tab and determine if corrective



Troubleshoot the Exchange mail provider

Exchange mail provider not supported for external usersExchange mail provider not supported for external users

Other notes

Troubleshooting
Where do workflow email templates come from?Where do workflow email templates come from?

Additional resources

NOTENOTE

actions should be taken.

5. In the Microsoft 365 admin center, verify that all user mail accounts that will be used to send emails have

Send AsSend As  and Send On Behalf OfSend On Behalf Of permissions for the configured SMTP account. For more information,

see Enable sending email from another user's mailbox in Microsoft 365.

6. Sign in to all user mailboxes to verify that they are valid and can be accessed using sign in.

7. Send a test email using System administrationSystem administration > SetupSetup > EmailEmail  > Email parametersEmail parameters  > Test emailTest email .

8. If the SMTP settings were migrated from another environment, clear the password field and re-enter the

password to ensure that the field encryption hasn't negatively affected the stored value.

9. If you continue to experience issues when email is sent via SMTP, enter the SMTP account information in a

tool such as SMTPer.net to verify that the SMTP server and account are valid and working correctly.

The Email parametersEmail parameters  page allows an administrator to select Exchange as an interactive email provider and as

the Batch email provider. The Exchange mail provider will use the current user's Exchange Online account to

send emails. When used as the Batch email provider, the batch account will be used. No additional configuration

is needed. If troubleshooting is needed, ensure that the current user's account can be signed into and that emails

can be sent from that account to the intended recipients.

Users that are external to the primary tenant will not have exchange accounts on that tenant, so the Exchange

mail provider is not supported for external users.

The system communicates with Exchange or an SMTP server like a typical email client, so standard behavior and

limits apply. For example, standard Exchange Online receiving and sending limits apply.

The email templates will be sourced from either system email templates or organization email templates

depending on whether the workflow is a system-level (not company specific) or organization-level (company

specific) workflow.

Troubleshoot the Office integration

Office integration tutorial

Configure email functionality in Microsoft Dynamics AX [AX 2012]

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://support.office.com/article/Enable-sending-email-from-another-user-s-mailbox-in-Office-365-2B828C5F-41AB-4904-97B9-3B63D8129C4E
https://www.smtper.net/
https://technet.microsoft.com/library/exchange-online-limits.aspx#RecipientLimits
https://technet.microsoft.com/library/aa834374.aspx
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Sending emails

ScenariosScenarios

Sending an interactive messageSending an interactive message

The SysMailer framework is a new, extensible way to send email. It replaces all previous application

programming interfaces (APIs) for mail, such as CDO.Messaging (SysMailer), MAPI (SysINetMail), and Outlook

COM (SmmOutlookEmail). Those older mail APIs won't work correctly in Finance and Operations applications.

By taking advantage of the SysPlugin framework and several .NET technologies, SysMailer provides a

configurable experience for users and enables the application consumers to remain agnostic to the email option

that users use to send email.

The SysMailer framework consists of a factory class that is used to retrieve an email provider, a set of email

providers that send messages, a message builder that builds the messages, and the forms that are related to

configuring and interacting with the email providers. To consume the SysMailer framework, an application

developer primarily uses the SysMailerFactor ySysMailerFactor y  and SysMailerMessageBuilderSysMailerMessageBuilder  classes. The email provider

factory is used to retrieve interactive or non-interactive email providers, so that multiple messages can be sent

at the same time, or so that a message can be sent directly. The email providers expect the messages that they

send to be encapsulated in .NET System.Net.Mail.MailMessageSystem.Net.Mail.MailMessage objects. The message builder class is used to

build the .NET object that is passed to the email provider.

This topic describes three scenarios:

Sending an interactive message

Sending a non-interactive (batch) message

Sending multiple non-interactive (batch) messages

The following example is taken from the CustCollectionsEmailCustCollectionsEmail  class. It demonstrates multiple features of the

framework, such as the ability to chain message builder calls, conditionally set the sender address ("from"

address), and add attachments.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/dev-tools/sysmailer-develop.md


using (System.IO.Stream attachmentStream = this.generateAttachment())
{
    var messageBuilder = new SysMailerMessageBuilder();
    messageBuilder.addTo(context.parmEmailAddress())
    .setSubject(emailSubject)
    .setBody(SysEmailMessage::stringExpand(emailBody,
    SysEmailTable::htmlEncodeParameters(templateTokens)));
    if (emailSenderAddr)
    {
        messageBuilder.setFrom(emailSenderAddr, emailSenderName);
    }
    else if (custParameters.CollectionsOMTeam)
    {
        var collectionsEmail = OMTeam::find(custParameters.CollectionsOMTeam).primaryEmail();
        if (strLen(collectionsEmail) > 0)
        {
            messageBuilder.setFrom(collectionsEmail);
        }
    }
    if (attachmentStream != null)
    {
        messageBuilder.addAttachment(
            attachmentStream,
            strFmt('%1%2', strReplace(DateTimeUtil::toStr(DateTimeUtil::utcNow()), ':', ''), '.xlsx'));
    }
    SysMailerFactory::sendInteractive(messageBuilder.getMessage());
}

Sending a non-interactive (batch) messageSending a non-interactive (batch) message

// The vendor <vendor name> has been approved and has been added to the vendor master.
messageText = strFmt("@SYS134393", DirPartyTable::findRec(vendRequestCompany.VendParty).Name);
// Request
var messageBuilder = new SysMailerMessageBuilder();
messageBuilder.setFrom(senderEmail)
    .addTo(recipientEmail)
    .setSubject("@SYS130372")
    .setBody(messageText);
SysMailerFactory::sendNonInteractive(messageBuilder.getMessage());

Sending multiple non-interactive (batch) messagesSending multiple non-interactive (batch) messages

The following example is taken from the VendRequestCompanyWorkflowManagerVendRequestCompanyWorkflowManager  class. It shows how you

can send a single message non-interactively.

The following example is taken from the UserAdAddManagerUserAdAddManager  class. It shows how you can get an instance of a

batch email provider before you iterate over a list of emails to send.



var mail = SysMailerFactory::getNonInteractiveMailer();
var messageBuilder = new SysMailerMessageBuilder();
for (i = 1; i <= conLen(_notifyCon); i++)
{
    notifyEmailsStr = conPeek(_notifyCon, i);
    select firstonly RecId, Email from sysUser where sysUser.Id == notifyEmailsStr;
    if (sysUser.RecId && sysUser.Email != '')
    {
        messageBuilder.reset()
            .setFrom(_emailFrom)
            .addTo(sysUser.Email)
            .setSubject("@SYS129183")
            .setBody(errorStr);
        mail.sendNonInteractive(messageBuilder.getMessage());
        delete_from tmpUserErrorNotification;
    }
}

Important considerationsImportant considerations

Adding a new email provider

A sender address ("from" address) is required when messages are sent to an email provider. A receiver

address ("to" address) is required when messages are sent non-interactively. If these conditions aren't

met, the framework throws an exception. If getMessagegetMessage is called on the message builder before any call

to setFromsetFrom is made, the builder tries to set the sender address to the current user's email address or

network alias.

When messages are sent, the way that the sender address ("from" address) is used depends on the

provider :

EML provider :EML provider : The sender address is removed from the message before the message is opened in

the user's email client. Therefore, the email client can set the sender address to the default account

that is configured for sending mail.

SMTP provider :SMTP provider : The Simple Mail Transfer Protocol (SMTP) server must be configured to allow

messages to be sent by using the sender address. In other words, the SMTP server must allow the

impersonation of emails that are sent from it. Otherwise, the SMTP server might prevent the

messages from being sent, flag them as spam, and so on.

When messages are sent, the framework returns a Boolean value that indicates whether the operation to

send the message was successful. However, it doesn't report any messages to the Action Center when the

operation is successful. You decide whether messages are shown in the Action Center.

By default, the body of all messages that are sent is in rich-text (HTML) format. If an application scenario

requires that plain text be used to maintain newline spacing, you can pass falsefalse to the optional _ isHtml_isHtml

parameter of the setBodysetBody  method on the message builder.

You can add email providers by using the pluggable framework. When you use the factory class and interfaces,

new email providers immediately become available for use across all relevant application scenarios. Examples of

email providers can be found in the existing provider implementations, SysMailerEML and SysMailerSMTP, and

also in an existing tutorial implementation, Tutorial_SysMailerMailTo. The examples that follow are excerpts from

the implementation of the SysMailerEML email provider.

To implement an email provider, you must create an implementation class that has the following properties:

The class must have the appropriate Expor tExpor t attributes.

The class must implement the base SysIMailerSysIMailer  methods, getIdgetId and getDescr iptiongetDescr iption.

The class must implement the SysImailer InteractiveSysImailer Interactive interface, the SysIMailerNonInteractiveSysIMailerNonInteractive interface,

or both interfaces.



Specify attributes for the implementation classSpecify attributes for the implementation class

using System.IO;
using System.Net.Mail;
using System.Text.RegularExpressions;
#define.SysMailerEML_ID('EML')
/// <summary>
/// The <c>SysMailerEML</c> class is an interactive email provider implementation that sends messages by 
generating
/// an EML file, uploading it to Azure temporary blob storage, and then redirecting the user's browser to
/// the file to save or open for sending using their default email client.
/// </summary>
// This is a framework class. Customizing this class may cause problems with future upgrades to the 
software.
[System.ComponentModel.Composition.ExportAttribute(identifierStr(Dynamics.AX.Application.SysIMailer)),
System.ComponentModel.Composition.ExportMetadataAttribute(extendedTypeStr(SysMailerId), #SysMailerEML_ID)]
public class SysMailerEML implements SysIMailerInteractive
{

Implement the SysIMailer interfaceImplement the SysIMailer interface

public SysMailerId getId()
{
    return #SysMailerEML_ID;
}
public SysMailerDescription getDescription()
{
    // Use an email app, such as Outlook
    return "@ApplicationFoundation:EmailProviderEMLDescription";
}

Implement a combination of the SysIMailerInteractive and SysIMailerNonInteractive interfacesImplement a combination of the SysIMailerInteractive and SysIMailerNonInteractive interfaces

The first step is to specify attributes for the implementation class. The class must have two attributes:

Expor tAttr ibuteExpor tAttr ibute – The framework uses this attribute to discover the plug-in. The attribute specifies that the

plug-in is an implementation of SysIMailerSysIMailer  and therefore part of the SysMailer framework.

Expor tMetadataAttr ibuteExpor tMetadataAttr ibute – The framework uses this attribute to find specific instances of a plug-in that

have specific metadata. The attribute specifies the ID of the email provider, so that a single provider can be

discovered quickly. No two email providers should ever have the same ID.No two email providers should ever have the same ID.

The SysIMailerSysIMailer  interface includes identifiable information about an email provider, regardless of the capabilities

of the email provider itself. To implement this interface, you must create two methods:

getIdgetId – This method returns the same ID that is specified in the Expor tMetadataAttr ibuteExpor tMetadataAttr ibute attribute.

getDescr iptiongetDescr iption – This method returns a non-technical description that indicates how the email will be sent.

The SysIMailer InteractiveSysIMailer Interactive and SysIMailerNonInteractiveSysIMailerNonInteractive interfaces are very simple. They implement the

sendInteractivesendInteractive and sendNonInteractivesendNonInteractive methods, respectively. An email provider might implement one or

both methods, depending on its capabilities. Each method that is implemented takes a .NET

System.Net.Mail.MailMessageSystem.Net.Mail.MailMessage object that you use to construct and send the email.



public boolean sendInteractive(System.Net.Mail.MailMessage _message)
{
    using (var emlStream = this.generateEmlFile(_message))
    {
        Dynamics.AX.Application.File::SendFileToUser(emlStream, 'message.eml');
    }
    return true;
}

Migration from Microsoft Dynamics AX 2012 to Finance and
Operations applications

NOTENOTE

The System.Net.Mail.MailMessageSystem.Net.Mail.MailMessage object contains a large amount of advanced functionality that is related to

MIME messages. You can build a relatively complex message object and pass it to an email provider. If there is

specific functionality that an email provider doesn't support, the email provider is expected to handle the

functionality actively (by modifying the message), passively (by making an internal call to another email

provider), or not at all (by throwing an error).

Migration involves using the SysMailerMessageBuilderSysMailerMessageBuilder  object to build a message and then using the

SysMailerFactor ySysMailerFactor y  to send it, as outlined in the examples in this topic.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Frequently asked questions
What platforms do the Office Add-ins support?What platforms do the Office Add-ins support?

Are the Office Add-ins safe?Are the Office Add-ins safe?

Does the Excel Add-in support Office for Mac?Does the Excel Add-in support Office for Mac?

What version of Office is required for the Excel Add-in to support AD FS?What version of Office is required for the Excel Add-in to support AD FS?

How can I force an update of Office?How can I force an update of Office?

Why can't you tell me what version of Office or Excel a particular issue is fixed in?Why can't you tell me what version of Office or Excel a particular issue is fixed in?

Why am I having trouble signing into the Excel Add-in?Why am I having trouble signing into the Excel Add-in?

Applies to these Dynamics 365 appsApplies to these Dynamics 365 apps :

Commerce, Finance, Human Resources, Supply Chain Management

This topic provides answers to questions, tips, and troubleshooting information about the capabilities of the

Microsoft Office integration. The questions and issues that are discussed range across user, administration, and

development scenarios.

The Microsoft Excel Add-in and Microsoft Word Add-in are built by using the Office Web/JavaScript Add-in

framework. This framework was originally released for Microsoft Office 2013 but received significant updates in

Microsoft Office 2016. For more information, see Office Add-in host and platform availability. The Excel Add-in

requires ExcelAPI 1.2. Therefore, use the Office Add-in host and platform availability matrix to determine which

platforms support the Excel Add-in. For many users, the phrase "Excel 2016 with the latest updates" is sufficient.

In an age of malware, full connectivity, and compliance risks, nothing is completely secure. However, the web

add-ins, like other websites, are basically a web application that interacts with the Office client products via a

limited application programming interface (API). For more details, see Office Add-ins platform overview

No. Support for Apple Mac and iOS is currently under development. The Office JavaScript (JS) APIs work

differently in Apple Safari and Internet Explorer, especially in respect to authentication. For details about

platform support for the Office JS APIs, see Office Add-in host and platform availability.

For more information, see the "Troubleshooting issue" section later in this topic.

If your Office build isn't updated, you might be on the deferred track (Overview of update channels for Microsoft

365 Apps). In this case, you can use the Office Deployment Tool to move to the Current channel or sign up for

the Office Insider program to help guarantee that you have the latest updates. The easiest method is to use the

Office Deployment Tool to switch to the Current channel. In this case, the latest updates will be installed

immediately.

Office has many releases. These releases receive updates at different times and have different version numbers

that don't correspond. Some frequently used Office versions and update methods are Click to Run (C2R) Current

channel, C2R Deferred, C2R First Update Deferred, Office Insider Fast, Office Insider Slow, and MSI/MSO (install

from DVD). For more information about Office versions, see the Release information for updates to Microsoft

365 Apps page.

The Excel Add-in runs inside an Internet Explorer window. By default, the Excel Add-in picks up stored credentials

from Internet Explorer, and Internet Explorer provides the current Microsoft Windows credentials if there are no

stored credentials. Make sure that you're using the correct credentials to sign in. In the Excel Add-in, explicitly

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/office-integration/office-integration-troubleshooting.md
https://docs.microsoft.com/en-us/office/dev/add-ins/overview/office-add-in-availability
https://docs.microsoft.com/en-us/office/dev/add-ins/overview/office-add-in-availability
https://docs.microsoft.com/en-us/office/dev/add-ins/overview/office-add-ins
https://docs.microsoft.com/en-us/office/dev/add-ins/overview/office-add-in-availability
https://technet.microsoft.com/library/mt455210.aspx
https://technet.microsoft.com/library/jj219422.aspx?f=255&MSPPError=-2147217396
https://products.office.com/office-insider
https://technet.microsoft.com/office/mt465751?f=255&MSPPError=-2147217396


The Excel Add-in seems to be slow when it publishes records. How can I learn more about what is occurring?The Excel Add-in seems to be slow when it publishes records. How can I learn more about what is occurring?

Why is the Export to Excel functionality limited to 10,000 records (prior to Platform update 22)?Why is the Export to Excel functionality limited to 10,000 records (prior to Platform update 22)?

sign out, and then sign in to help guarantee that the correct credentials are used.

Most of the work that the Excel Add-in does should occur on the server. To learn where the time is being spent,

you can use Fiddler (a free download) to make sure that the Excel Add-in works as you expect.

The Excel Add-in sends the published records as a request. When those records are processed, the response is

sent back from the server. The Excel Add-in then creates another message that contains the next set of records to

publish, and sends that request. Five to ten seconds of processing time in the Excel Add-in should be required

between the previous response from the server and the next request to the server.

To check processing time in the Excel Add-in versus the server/service, follow these steps.

1. Start Fiddler.

2. Publish a few records to test the process.

3. Make sure that you can view that request and response in Fiddler (make sure that HTTPS traffic is being

decrypted).

4. Publish a larger number of records.

5. In Fiddler, watch the time that is required from a request to its response, and from a response to the next

request.

If the time from a request to its response is large, the bottleneck is the server/service.

If the time from a response to the next request is large, the bottleneck is the Excel Add-in (that is, the

client).

Prior to Platform update 22, the Export to Excel functionality is limited to 10,000 records. This limitation is in

place because the export process uses the form from which data is being exported to provide the following

records with fields and data that can't be obtained otherwise: formatted values, calculated values, and

temporary table data. Because the form is used during the export, it occurs inside the client process that is

shared by all the users on a given computer. During the export, those other users are blocked from interacting

with the client.

With Platform update 22 and later, Export to Excel has a progress dialog box and is no longer a blocking process

for other users, so larger datasets can be exported. Exporting data via Export to Excel will be slower than using

the Excel Add-in or the Data Management framework, but it will return exactly the data shown in the grid. This is

useful for filtered datasets. The user is presented with a dialog box that allows them to stop at any point.

Because the export can take some time, it is recommended that the export is done with the Chrome or Edge

browsers, with the automatic download option enabled. The automatic download option will ensure that the

browser downloads the file as soon as the export is complete to ensure that the download link is used within the

15-minute time limit.

The ideal alternative to Export to Excel is to use Open in Excel and the Excel Add-in. The Excel Add-in retrieves

data by using the OData service, and takes advantage of the security that the entities provide. The import and

export capabilities in the Data management framework (DMF) and Data import/export framework (DIXF) can

also be used. However, DMF/DIXF is often limited to administrators.

If you have concerns about giving users access to the data via the Excel Add-in, because they should not be able

to update records, consider the following points:

The entities should have all the validation and logic that the forms have. If they don't, it's a bug.

The way that entities are secured resembles the way that forms are secured. Therefore, if a user should not

have permission to update or write data by using a form that exposes that data, the user should not have

permission to update or write data by using an entity that exposes that data.

https://www.telerik.com/fiddler
https://www.telerik.com/fiddler
https://docs.telerik.com/fiddler/Configure-Fiddler/Tasks/DecryptHTTPS


Why is the Publish button in the Excel Add-in unavailable?Why is the Publish button in the Excel Add-in unavailable?

Why are the Excel Add-in, the Word Add-in, and the Open in Excel options only available when the Internet isWhy are the Excel Add-in, the Word Add-in, and the Open in Excel options only available when the Internet is
available?available?

Can the Excel Add-in and Word Add-in be made available to users using Centralized Deployment?Can the Excel Add-in and Word Add-in be made available to users using Centralized Deployment?

NOTENOTE

What is the cell limit for the Excel Add-in?What is the cell limit for the Excel Add-in?

How do I make an entity available in the Excel Add-in and/or as an Open in Excel option?How do I make an entity available in the Excel Add-in and/or as an Open in Excel option?

Why are date and time values in UTC in the Excel Add-in?Why are date and time values in UTC in the Excel Add-in?

All key and mandatory fields must be present to publish data back to the entity. Try to edit the design to add

more fields to the binding.

For all environments, including on-premises, the Excel and Word Add-ins, and the libraries they use, are loaded

from multiple Internet locations and therefore will only run when the Internet is available. For on-premises

environments, when the Internet is not available, the Open in Excel options are hidden because the Excel Add-in

will not run without access to the Content Delivery Network (CDN) that houses the Excel Add-in.

Yes, Centralized Deployment is supported. For more information, see Centralized Deployment.

To use Centralized Deployment, on the App parametersApp parameters  tab on the Office App ParametersOffice App Parameters  page change the

App IDApp ID, StoreStore, and Store TypeStore Type:

App IDApp ID: 61bcc63f-b860-4280-8280-3e4fb5ea7726

StoreStore: EXCatalog

Store TypeStore Type: Centralized Deployment

In case a change back to Office Store is needed, the standard values are:

App IDApp ID: WA104379629

StoreStore: en-US

Store TypeStore Type: Office Store

NameName, VersionVersion, and NotesNotes are values that provide information but they are not needed to run the Excel Add-in.

These same values are also used for the Word Add-in when it is run from the Document Templates form.

If you encounter issues with Centralized Deployment for some users, it could be one of these problems:

One or more users are members in a group that is more restrictive than others

The user referenced is on a different Microsoft 365 account (such as a personal account)

The default Excel Add-in cell limit is about half the limit of what the Excel Add-in can handle on a reasonably fast

machine. The speed of the machine is the limitation. If problems are encountered, then the cell limit should be

reduced and/or the filter should be adjusted to reduce the data set. A common workaround is to use a filter to

manage the data in smaller pieces instead of all at once.

If the entity is marked as “IsPublic=Yes” and has unique PublicEntityName and PublicCollectionName values,

then it will be available via the OData service. Check that there aren’t any existing entities with the same

PublicEntityName and PublicCollectionName values by looking at the $metadata feed for the environment

(preferably in Google Chrome): https://SomeFullEnvironmentURL.dynamics.com/data/$metadata

The Excel Add-In, Data Management Framework, and Power BI reporting are all designed to interact with data

directly on the database level. Because there is no client to adjust Date and Time data to the time zone of the

user, all Date and Time values are in UTC.

https://docs.microsoft.com/en-us/office/dev/add-ins/publish/centralized-deployment


Troubleshooting issues
[Fixed] Issue: During sign-in to the Excel Add-in, I receive the following error message: "AADSTS65001: The[Fixed] Issue: During sign-in to the Excel Add-in, I receive the following error message: "AADSTS65001: The
user or administrator has not consented to use the application with ID XYZ"user or administrator has not consented to use the application with ID XYZ"

[Fixed] Issue: During sign-in to the Excel Add-in, I receive the following error message: "AADSTS50001: The[Fixed] Issue: During sign-in to the Excel Add-in, I receive the following error message: "AADSTS50001: The
application named ABC was not found in the tenant named XYZ"application named ABC was not found in the tenant named XYZ"

[Fixed] Issue: After the Excel Add-in starts and updates data, I receive the following error message: "An error[Fixed] Issue: After the Excel Add-in starts and updates data, I receive the following error message: "An error
occurred while writing to the data cache"occurred while writing to the data cache"

Issue: When I send email by using SMTP, the server response is "5.7.60 SMTP; Client does not haveIssue: When I send email by using SMTP, the server response is "5.7.60 SMTP; Client does not have
permissions to send as this sender"permissions to send as this sender"

Issue:Issue: During sign in to the Excel Add-in, you receive the following error message: "AADSTS65001: The user or

administrator has not consented to use the application with ID XYZ."

Explanation:Explanation: Typically, this issue occurs because Microsoft Azure Active Directory (Azure AD) can't find the

Azure AD application that represents the Excel Add-in. That issue occurs because, during the configuration of

Microsoft Power BI, an Azure AD application was added that has the App ID URI set to the environment URL.

Fix:Fix: Make sure that no Azure AD apps have the App ID URI set to the environment URL. App ID URIs should be

fabricated, unique URIs, such as https://contosoAXPowerBI .

Issue:Issue: During sign-in to the Excel Add-in, you receive the following error message: "AADSTS50001: The

application named ABC was not found in the tenant named XYZ."

Explanation:Explanation: This issue probably occurs because an error in the deployment system caused the environment to

get a URL that wasn't added to the configured list of service principals for the tenant.

Fix:Fix: File a support issue for your environment, so that the problem can be investigated and the configuration

can be adjusted.

Issue:Issue: After the Excel Add-in starts and updates data, you receive the following error message: "An error

occurred while writing to the data cache." The details of the error state, "The argument is invalid or missing or

has an incorrect format."

Explanation:Explanation: You receive this error message if the client is open in Internet Explorer, and the user clicks OpenOpen

immediately after selecting the Open in ExcelOpen in Excel  option. The way that Internet Explorer handles temporary

Internet files causes an issue in Excel. This issue, in turn, causes API calls to fail.

Workaround:Workaround: In Internet Explorer, when you open a workbook, click SaveSave first, and then click OpenOpen. The file

will then be opened from your Downloads folder. Alternately, use the Edge or Google Chrome browser. By

default, both these browsers save files to a Downloads folder. Therefore, the issue doesn't occur.

Long-term fix:Long-term fix: We are working with the Office team to understand this issue so that it can be fixed in Excel.

Issue:Issue: When you send email by using Simple Mail Transfer Protocol (SMTP), you might receive an error

message that states that the server response was "5.7.60 SMTP; Client does not have permissions to send as this

sender." Alternatively, the error message might state, "Something went wrong while generating the report."

Explanation:Explanation: This issue is usually caused by incorrect setup of the Send As permissions for the email account.

Fix:Fix: You can configure Send As permissions in the Microsoft 365 admin center (portal.office.com/Admin). Click

UsersUsers  > Active usersActive users  > UserUser  > Edit mailbox permissionsEdit mailbox permissions  > Send email from this mailboxSend email from this mailbox. For more

information, see Give mailbox permissions to another user in Microsoft 365 - Admin Help.

The following illustration shows the setup of SMTP on the Email parametersEmail parameters  page. Here, you must provide the

outgoing mail server, port, user name, password, and Secure Sockets Layer (SSL) requirements.

https://support.office.com/article/Enable-sending-email-from-another-user-s-mailbox-in-Office-365-2B828C5F-41AB-4904-97B9-3B63D8129C4E


IMPORTANTIMPORTANT

[Fixed] Issue: The Office Add-ins don't yet support AD FS[Fixed] Issue: The Office Add-ins don't yet support AD FS

All users must give the SMTP account Send As permissions on their email setup in Microsoft 365. This configuration is

done in the mailbox permissions in Microsoft Exchange or in the Microsoft 365 Admin portal. The following illustration

shows the setup for the Test User account, where the STMP service account is added in the Send AsSend As section.

Affected versions:Affected versions: CTP8 and the February 2016 releases

Issue:Issue: When users from an Azure AD tenant that uses Active Directory Federation Services (AD FS) try to sign in

to the Office Add-ins (in other words, when the users enter their account, and then press Tab or click in the field

to enter their password), a separate browser window opens. This browser window usually has a URL that starts

with https://az689774.vo.msecnd.net/dynamicsofficeapp/v1.2.1.0/App/DynamicsApp.html\#id\_token= . The user

can't sign in.

Explanation:Explanation: During sign-in to the Office add-ins (both the Excel Add-in and the Word Add-in), a redirect to the

AD FS site for the tenant occurs. However, that site is an unknown and therefore disallowed application domain

(AppDomain).

file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/office-integration/media/smtp.png
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/office-integration/media/o365.png


Workaround: Use Internet Explorer to sign in to the client before you use the Office Add-insWorkaround: Use Internet Explorer to sign in to the client before you use the Office Add-ins

[Fixed] Issue: The Excel Add-in doesn't correctly run or enable sign-in[Fixed] Issue: The Excel Add-in doesn't correctly run or enable sign-in

Long-term fix:Long-term fix: The long-term fix for this issue was put in place on May 10, 2016. The Office Add-ins now use a

new Dialog API that the Office team added.

Taking advantage of the add-in updates that suppor t AD FS :Taking advantage of the add-in updates that suppor t AD FS : All Office installations should be updated

via FileFile > AccountAccount > UpdatesUpdates  (for click-to-run installations) or via Windows Update (for MSI installations). The

AD FS Dialog API was included in the May update (16.0.6868.2060). For information about updates, see the

Microsoft 365 client update channel releases page.

If your Office build isn't updated, you might be on the deferred track (Overview of update channels for Microsoft

365 Apps). In this case, you can use the Office Deployment Tool to move to the Current channel or sign up for

the Office Insider program to help guarantee that you have the latest updates. Additionally, see Install the latest

version of Office and Office 2016 Deployment Guides for Admins.

If Office updates can't be installed, the following workaround can unblock users.

This workaround requires user knowledge and extra steps. After users have been educated about this

workaround, it should be straightforward for them.

User steps:User steps: Before users open Excel (or Word), they should sign in to the client by using Internet Explorer.

Explanation:Explanation: The Excel or Word Add-in will use the sign-in context, and no redirect will be required. The earlier

sign-in must occur in Internet Explorer, because the Office Add-ins run inside an Internet Explorer window in

Excel and Word. The sign-in context lasts 6 to 24 hours, depending on policies. Therefore, a new sign-in through

Internet Explorer is required only occasionally.

1. Exit Internet Explorer and Excel.

2. Start Internet Explorer, and sign in to the client.

3. Test the Excel Add-in by using an Open in Excel experience. (For example, click Fleet ManagementFleet Management >

CustomersCustomers  > CustomerCustomer  > Open in Microsoft OfficeOpen in Microsoft Office > Open in ExcelOpen in Excel  > Fleet ManagementFleet Management

CustomersCustomers .)

Issue:Issue: When users try to sign into the Excel Add-in, a blank authentication dialog box appears, or an error

message is shown instead of the authentication page. The user can't sign in.

Explanation:Explanation: The Excel Add-in relies on the Office Web JS Add-in platform and uses Azure AD for

authentication. If a proxy is used, several URLs must be accessible for users to run and sign in to the Excel Add-

in. Additionally, if AD FS is used, the AD FS URL must use HTTPS.

Solution:Solution: Because this issue is a customer-specific network issue, it requires a customer-specific resolution. If

AD FS is used, make sure that the AD FS URL uses HTTPS. Additionally, make sure that all the following URLs are

accessible from the user's computer.

The following URLs are accessed for loading.

https://az689774.vo.msecnd.net:443

https://az689774.vo.msecnd.net

https://appsforoffice.microsoft.com:443

https://appsforoffice.microsoft.com

https://secure.aadcdn.microsoftonline-p.com:443

https://secure.aadcdn.microsoftonline-p.com

https://az416426.vo.msecnd.net:443

https://az416426.vo.msecnd.net

https://telemetryservice.firstpartyapps.oaspapps.com:443

https://technet.microsoft.com/office/mt465751?f=255&MSPPError=-2147217396
https://technet.microsoft.com/library/mt455210.aspx
https://technet.microsoft.com/library/jj219422.aspx?f=255&MSPPError=-2147217396
https://products.office.com/office-insider
https://docs.microsoft.com/en-us/office/dev/add-ins/develop/install-latest-office-version
https://technet.microsoft.com/library/cc303401(v=office.16).aspx


Issue: The Excel Add-in needs an explicit sign out after encountering an AADSTS50058 "silent sign in failed"Issue: The Excel Add-in needs an explicit sign out after encountering an AADSTS50058 "silent sign in failed"
errorerror

Issue: When trying to use a document template with Open in Excel a "Record for id GUID not found" errorIssue: When trying to use a document template with Open in Excel a "Record for id GUID not found" error
displaysdisplays

Additional resources

NOTENOTE

https://telemetryservice.firstpartyapps.oaspapps.com

https://nexus.officeapps.live.com:443

https://nexus.officeapps.live.com

https://browser.pipe.aria.microsoft.com:443

https://browser.pipe.aria.microsoft.com

http://schemas.microsoft.com

The following URLs are accessed for authentication.

https://login.windows.net:443

https://login.windows.net

https://login.microsoftonline.com:443

https://login.microsoftonline.com

Issue:Issue: When users try to sign in to the Excel Add-in after some period of inactivity, the user encounters the

AADSTS50058 "silent sign in failed" error and is forced to sign out before signing back in.

Explanation:Explanation: The Excel Add-in uses Azure AD for authentication. When authentication occurs, a token is created

for the user. That token has an expiration period. After the token has expired, an AADSTS50058 error will occur

indicating that "silent sign in failed".

Solution:Solution: The user needs to sign out and sign back in. We will improve this behavior in the future by

automatically signing the user out to enable faster sign in.

Issue:Issue: The "Record for id GUID not found" error can display when copying a database from one environment to

another.

Explanation:Explanation: Copying the database is problematic for document templates, record attachments, and other files

that are stored in Azure blob storage. When the database is copied from one environment to another, the files

are not copied along with the records, so the files that the application tries to access are not found.

Solution:Solution: For document templates, the solution is to identify the templates that are needed and load a copy of

those template files into the target environment.

Office integration

Office integration tutorial

Configuring Power BI integration

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Number sequences

Organizations

Address books

This topic points to content that will help power users and administrators configure the system to work

smoothly and effectively for your organization and business.

Much of the content listed here applies to features in the Organizational administrationOrganizational administration module. However,

there are a couple of tasks, such as creating and using a record template, that can be performed in any module

to help your organization run more efficiently.

Number sequences are used to generate readable, unique identifiers for master data records and transaction

records that require identifiers. A master data record or transaction record that requires an identifier is referred

to as a reference. Before you can create new records for a reference, you must set up a number sequence and

associate it with the reference.

Number sequences overview

Set up number sequences using a wizard (Task guide)

Set up number sequences on an individual basis (Task guide)

An organization is a group of people who are working together to carry out a business process or achieve a

goal. Organizational hierarchies represent the relationships between the organizations that make up your

business.

Before you set up organizations and organization hierarchies, make sure that you plan how your business will

be modeled. The organization model has a significant effect on implementation and business processes.

Organizations and organizational hierarchies overview

Plan your organizational hierarchy

Create an organization hierarchy (Task guide)

Create a legal entity (Task guide)

Create an operating unit (Task guide)

The global address book is a centralized repository for master data that must be stored for all internal and

external persons and organizations that the company interacts with. The data that is associated with party

records includes the party's name, address, and contact information.

After you create the global address book, you can create additional address books as you require, such as a

separate address book for each company in your organization or for each line of business.

Global address book overview

Plan for the global address book and other address books

Configure the global address book

Address books FAQ

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/organization-administration-home-page.md


Workflow

Electronic signatures

Case management

Record templates

General organization administration

NOTENOTE

Workflow is a system that you can use to create individual workflows, or business processes. When you create a

workflow, you specify how a document flows, or moves, through the system by showing who must complete a

task, make a decision, or approve a document.

Workflow system overview

Workflow elements

Actions in workflow approval processes

Create workflows overview

An electronic signature confirms the identity of a person who is about to start or approve a computing process.

In some industries, an electronic signature is as legally binding as a handwritten signature. Electronic signatures

are a regulations compliance requirement for several regulated industries, such as pharmaceuticals, food and

beverage, and aerospace and defense.

You can use electronic signatures for critical business processes. Some processes have built-in electronic

signature capabilities. You can also create custom signature requirements for any database table and field.

Electronic signatures overview

Set up electronic signatures (Task guide)

By planning, tracking, and analyzing cases, you can develop efficient resolutions that can be used for similar

issues. For example, when customer service representatives or Human Resources generalists create cases, they

can find information in knowledge articles to help them work with or resolve a case more efficiently.

Case management overview

Plan case category security, case processes, and case categories

Record templates can help you to create records more quickly. You can create a record template so that field

values that are used often do not have to be entered explicitly for each new record.

Record templates overview

Create a record template to facilitate data entry (Task guide)

Use record template to create a new record (Task guide)

Change the banner or logo (Task guide)

Configure document management

Configure and send email

Date/time data and time zones

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Number sequence examples

Expense report numbersExpense report numbers

SEGM EN T SSEGM EN T S SEGM EN T  T Y P ESEGM EN T  T Y P E VA L UEVA L UE

Segment 1 Legal entity CS

Segment 2 Constant -EXPENSE-

Number sequences are used to generate readable, unique identifiers for master data records and transaction

records that require identifiers. A master data record or transaction record that requires an identifier is referred

to as a reference.

Before you can create new records for a reference, you must set up a number sequence and associate it with the

reference. We recommend that you use the pages in Organization administrationOrganization administration to set up number

sequences. If module-specific settings are required, you can use the parameters page in a module to specify

number sequences for the references in that module. For example, in Accounts receivableAccounts receivable and AccountsAccounts

payablepayable, you can set up number sequence groups to allocate specific number sequences to specific customers

or vendors.

When you set up a number sequence, you must specify a scope, which defines which organization uses the

number sequence. The scope can be SharedShared, CompanyCompany , Legal entityLegal entity , or Operating unitOperating unit. Legal entityLegal entity  and

CompanyCompany  scopes can be combined with Fiscal calendar periodFiscal calendar period to create even more specific number

sequences.

Number sequence formats consist of segments. Number sequences with a scope other than SharedShared can contain

segments that correspond to the scope. For example, a number sequence with a scope of Legal entityLegal entity  can

contain a legal entity segment. By including a scope segment in the number sequence format, you can identify

the scope of a particular record by looking at its number.

In addition to segments that correspond to scopes, number sequence formats can contain ConstantConstant and

Alphanumeric segmentsAlphanumeric segments . A ConstantConstant segment contains a set of letters, numbers, or symbols that does not

change. An AlphanumericAlphanumeric segment contains a set of letters or numbers that increment every time that a

number is used. Use a number sign (#) to represent incrementing numbers and an ampersand (&) to represent

incrementing letters. For example, the format #####_2017 creates the sequence 00001_2017, 00002_2017, and

so on.

The following examples show how to use segments to create number sequence formats. In particular, the

examples demonstrate the effects of using scope segments.

In the following example, expense report numbers are set up for the legal entity that is titled CSCS .

Area:Area: Travel and expense

Reference:Reference: Expense report number

Scope:Scope: Legal entity

Legal entity:Legal entity: CS

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/number-sequence-overview.md


Segment 3 Alphanumeric ####

SEGM EN T SSEGM EN T S SEGM EN T  T Y P ESEGM EN T  T Y P E VA L UEVA L UE

Sales order numbersSales order numbers

SEGM EN T SSEGM EN T S SEGM EN T  T Y P ESEGM EN T  T Y P E VA L UEVA L UE

Segment 1 Constant SO-

Segment 2 Alphanumeric ####

Purchase requisition numbersPurchase requisition numbers

SEGM EN T SSEGM EN T S SEGM EN T  T Y P ESEGM EN T  T Y P E VA L UEVA L UE

Segment 1 Constant Req

Segment 2 Alphanumeric ####

Performance considerations for number sequences

Example of formatted numberExample of formatted number : CS-EXPENSE-0039

You can set up a similar number sequence format for other legal entities. For example, for a legal entity that is

named RWRW, if you change only the value of the legal entity segment, the formatted number is RW-EXPENSE-

0039. You can also change the whole number sequence format for other legal entities. For example, you can

omit the legal entity scope segment to create a formatted number such as Exp-0001.

In the following example, sales order numbers are set up for the company ID CEUCEU.

Area:Area: Sales

Reference:Reference: Sales order

Scope:Scope: Company

Company:Company: CEU

Example of formatted numberExample of formatted number : SO-0029

Even though a scope segment is not included in the format, numbering restarts for each company ID. If you use

the same format for all company IDs, the same numbers are used in each company. For example, sales order

number SO-0029 is used in each company. You can also change the whole number sequence format for other

company IDs.

In the following example, purchase requisition numbers are organization-wide.

Area:Area: Purchase

Reference:Reference: Purchase requisition

Scope:Scope: Shared

Example of formatted numberExample of formatted number : Req0052

Because the scope is SharedShared, the number sequence format is used across the organization. You cannot set up

different number sequence formats for different parts of the organization.

Consider the following information about how the configuration of number sequences can affect system

performance before you set up number sequences.



Continuous and non-continuous number sequencesContinuous and non-continuous number sequences

Automatic cleanup of number sequencesAutomatic cleanup of number sequences

NOTENOTE

Number sequences can be continuous or non-continuous. A continuous number sequence does not skip any

numbers, but numbers may not be used sequentially. Numbers from a non-continuous number sequence are

used sequentially, but the number sequence may skip numbers. For example, if a user cancels a transaction, a

number is generated, but not used. In a continuous number sequence, that number is recycled later. In a non-

continuous number sequence, the number is not used.

Continuous number sequences are typically required for external documents, such as purchase orders, sales

orders, and invoices. However, continuous number sequences can adversely affect system response times

because the system must request a number from the database every time that a new document or record is

created.

If you use a non-continuous number sequence, you can enable PreallocationPreallocation on the PerformancePerformance FastTab of

the Number sequencesNumber sequences  page. When you specify a quantity of numbers to preallocate, the system selects those

numbers and stores them in memory. New numbers are requested from the database only after the

preallocated quantity has been used.

Unless there is a regulatory requirement that you use continuous number sequences, we recommend that you

use non-continuous number sequences for better performance.

In case of a power failure, an application error, or other unexpected failure, the system cannot recycle numbers

automatically for continuous number sequences. You can run the cleanup process manually or automatically to

recover the lost numbers.

Carefully consider server usage when you plan the cleanup process. We recommend that you perform the

cleanup as a batch job during non-peak hours.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Set up number sequences on an individual basis
2/18/2021 • 2 minutes to read • Edit Online

This topic explains how to set up number sequences on an individual basis. Number sequences are used to

generate readable, unique identifiers for master data records and transaction records that require them. A

master data or transaction record that requires an identifier is referred to as a reference. Before you can create

new records for a reference, you must set up a number sequence and associate it with the reference. You can set

up all required number sequences at the same time by using the Set up number sequencesSet up number sequences  wizard, or you

can create or modify individual number sequences by using the Number sequencesNumber sequences  page.

1. Go to Navigation pane > Modules > Organization administration > Number sequences >Navigation pane > Modules > Organization administration > Number sequences >

Number sequencesNumber sequences .

2. Select Number sequenceNumber sequence.

3. In the Number sequence codeNumber sequence code field, type a value.

4. In the NameName field, type a value.

5. On the Scope parametersScope parameters  FastTab, select a scope for the number sequence and select scope values from

the drop-down list. The scope defines which organizations use the number sequence. In addition, number

sequences that have a scope other than SharedShared can have segments that correspond to their scope. For

example, a number sequence with a scope of Legal entityLegal entity  can have a legal entity segment. For more

information about scopes, see Number sequence overview.

6. Expand the SegmentsSegments  section.

7. Expand the ReferencesReferences  section. Select the document type or record to assign this number sequence to. This

step is optional for sequences that are defined for special application usage patterns. In these scenarios, a

new number is generated by using the value of a number sequence code or ID, without using a reference. An

example of a special application usage pattern is a voucher series that is used for specific journal names.

However, we do not recommend that you use such patterns.

8. Expand the GeneralGeneral  section. On the General FastTab, specify whether the number sequence is manual, and

continuous or non-continuous. In addition, enter the lowest and highest numbers that can be used in the

number sequence. We do not recommend changing a non-continuous number sequence to a continuous

number sequence. The number sequence will not be truly continuous. This change may also cause duplicate

key violations in the database. In addition, continuous number sequences have a larger effect on

performance.

9. Click SaveSave.

Define the format for the number sequence by adding, removing, and rearranging segments.

Number sequences of all scopes can contain Constant segments and Alphanumeric segments.

Constant segments contain a set of alphanumeric characters that do not change. Use this segment

type to add a hyphen or other separators between number sequence segments. Alphanumeric

segments contain a combination of number signs (#) and ampersands (&). These characters represent

letters and numbers that increment every time that a number from the sequence is used. Use a

number sign (#) to indicate incrementing numbers and an ampersand (&) to indicate incrementing

letters. For example, the format #####_2014  creates the sequence 00001_2014 , 00002_2014 , and so on.

At least one alphanumeric segment must be present. Scope segments, such as company or legal

entity, are not required. However, if you do not include scope segments in the format, numbers for the

selected reference are still generated per scope.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/tasks/set-up-number-sequences-individual-basis.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/organization-administration/number-sequence-overview
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NOTENOTE

Number sequences are used to generate readable, unique identifiers for master data records and transaction

records that require them. A master data or transaction record that requires an identifier is referred to as a

reference. Before you can create new records for a reference, you must set up a number sequence and associate

it with the reference. This topic explains how to set up all required number sequences at the same time by using

a wizard. The demo data company used to create this procedure is USMF.

1. Go to Navigation > Modules > Organization administration > Number sequences > NumberNavigation > Modules > Organization administration > Number sequences > Number

sequencessequences .

2. Select GenerateGenerate.

3. Select NextNext.

On this page, you can modify the identification code, the lowest value, and the highest value. In

addition, you can indicate whether the number sequence must be continuous.

Do not select the ContinuousContinuous  option if you must preallocate numbers for the number sequence. To

add a scope segment to the format of a number sequence, select the format in the list, and then select

Include scope in formatInclude scope in format. To remove a scope segment from the format of a number sequence, select

the format in the list, and then select Remove scope from formatRemove scope from format. To exclude a number sequence

from automatic generation, select the number sequence in the list, and then select DeleteDelete.

4. Select NextNext.

5. Select FinishFinish .

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Turn on the Number sequence extensions feature

Set up the feature

The Number sequence extensions feature adds a new configuration page for setting up number sequences. It

enables flexible configuration of GS1-regulated IDs, including GS1 prefixes and check digits (modulo 10), and

enforces a length limit on existing number sequences.

Standard number sequence segments aren't suitable for GS1 implementation, because no check digit is

calculated, and the company's GS1 prefix must be updated manually.

This feature adds the following functionality:

Bill of lading (BOL) IDs can be generated in advance.

A unique number sequence can be generated for serial shipping container code (SSCC) numbers.

GS1-compliant number sequences can be created for BOL and SSCC numbers. The feature adds out-of-box

support for license plate IDs, container IDs, wave label IDs, and BOL IDs.

Configuration of license plate ID numbers is flexible. For example, you can include or exclude application

identifiers (AI), such as leading zeros (00).

This functionality makes it more efficient to support labeling of cartons and to adjust new numbers that are

generated by the system.

Before you can use the feature, it must be turned on in your system. Admins can use the Feature management

workspace to check the status of the feature and turn it on if it's required. There, the feature is listed in the

following way:

Module:Module: Warehouse management

Feature name:Feature name: Number sequence extensions

To set up number sequence extensions in your system, follow these steps.

NOTENOTE

1. Go to Warehouse management > Setup > Warehouse management parametersWarehouse management > Setup > Warehouse management parameters .

2. On the GeneralGeneral  tab, in the GS1 company prefixGS1 company prefix field, and enter your company's GS1 prefix. This value

will affect all number sequences where the GS1 prefix is included as a segment.

3. If you want to generate BOL numbers for wave labels, on the Repor tsRepor ts  tab, select the Generate BOLGenerate BOL

number when printing wave labelsnumber when printing wave labels  check box.

This check box is available only if the functionality for wave label printing is turned on.

4. Go to Warehouse managementWarehouse management > SetupSetup > Number sequence extensionsNumber sequence extensions

5. On the Action Pane, select Create default setupCreate default setup. A GS1-compliant BOL number sequence and three

types of SSCC number sequences are created. All these number sequences take the length of your

company's GS1 prefix into account.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/configure-number-sequence-extensions.md
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Create and edit number sequences

For more information about how to customize these default number sequences and/or add new

sequences, see the next section. You can also remove any of these sequences if you don't need them.

6. Go back to Warehouse management > Setup > Warehouse management parametersWarehouse management > Setup > Warehouse management parameters .

7. On the Number sequencesNumber sequences  tab, select a relevant number sequence extension to use to generate

numbers for your license plate IDs, wave label IDs, container IDs (in this case, select the appropriate

SSCC-18 numberSSCC-18 number  sequence), and/or BOL IDs (in this case, select the BOLBOL  sequence). By default, number

sequence extensions are supported only for these four types of IDs.

The next time that a new number is generated for one of these number sequences, the new logic will be used.

If you don't select a number sequence extension for license plate IDs, the current rules for generating license plate IDs will

be used. Otherwise, your selected number sequence will be used. The other IDs will use a plain number sequence until

you apply a number sequence extension for them.

In the previous section, you generated a default set of number sequences. This section explains how each

number sequence is defined. It also explains how to create custom sequences, and how to edit the default or

custom sequences.

To create and edit number sequences, follow these steps.

SEGM EN T  T Y P ESEGM EN T  T Y P E DESC RIP T IO NDESC RIP T IO N

Constant This segment type adds the same constant text for each
generated number in the sequence. In the ValueValue field,
enter the required text. The LengthLength field is automatically
updated to the length of the text that you entered in the
ValueValue field.

Number sequence In the ValueValue field, enter a number sign (#) for each
character that should be shown in the generated
sequence. The number sequence itself might generate
longer numbers, but only the right-most characters will
be shown. The LengthLength field is automatically updated to
the number of number signs that you entered in the
ValueValue field.

1. Go to Warehouse managementWarehouse management > SetupSetup > Number sequence extensionsNumber sequence extensions .

2. On the Action Pane, select NewNew .

3. In the Number sequence extensionNumber sequence extension field, enter a name for the new sequence. In the Descr iptionDescr iption field,

enter a description.

4. On the SegmentsSegments  FastTab, use the buttons on the toolbar to assemble your numbering format by

adding, deleting, and arranging segments. In the SegmentSegment field for each row, assign a segment type to

define the purpose and content of that segment. The following table describes the types of segments that

are available.

To comply with GS1 requirements for SSCC-18
numbers, make sure that the length of this segment
is 16 minus the length of your GS1 prefix.
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GS1 prefix This segment type adds the value that is set in the GS1GS1
company prefixcompany prefix field on the WarehouseWarehouse
management parametersmanagement parameters  page. The ValueValue field
shows the value that is set on the WarehouseWarehouse
management parametersmanagement parameters  page, and the LengthLength field
shows the number of characters in the value. Both the
ValueValue field and the LengthLength field are read-only.

Application identifier In the ValueValue field, enter an application identifier, as
specified by the relevant GS1 policy for this type of
number sequence. For example, enter 00 for SSCC or
420 for BOL. The LengthLength field is automatically updated
to the length of the identifier that you entered in the
ValueValue field.

Packing type For items that can be clearly identified, this segment type
adds a field value from the relevant unit sequence group
(from the Unit sequence groupsUnit sequence groups page). (This behavior
matches the existing logic for license plate IDs.) For
license plates that include multiple stock keeping units
(SKUs), this segment type adds 0 (zero) by default. For
this segment type, the ValueValue field is always set to P, and
the LengthLength field is always set to 1.

Check digit This segment type adds a check digit, which is a modulo
10 calculation. (This behavior matches the existing logic
for license plate IDs.) For this segment type, the ValueValue
field is always set to a caret (^), and the LengthLength field is
always set to 1.
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5. To view an example of your final number format, inspect the FormatFormat field at the bottom of the

SegmentsSegments  FastTab.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Organizations

Legal entitiesLegal entities

Operating unitsOperating units
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Cost center An operating unit in which managers
are accountable for budgeted and
actual expenditures.

Used for the management and
operational control of business
processes that span legal entities.

Business unit A semi-autonomous operating unit
that is created to meet strategic
business objectives.

Used for financial reporting that is
based on industries or product lines
that the organization serves
independently of legal entities.

Value stream An operating unit that controls one or
more production flows.

Commonly used in lean manufacturing
to control the activities and flows that
are required to supply a product or
service to consumers.

An organization is a group of people who are working together to carry out a business process or achieve a

goal. Organizational hierarchies represent the relationships between the organizations that make up your

business.

You can define the following types of internal organizations: legal entities, operating units, and teams.

All internal organizations are types of the Par tyPar ty  entity. Therefore, these organizations use the address book to

store address and contact information. A party, which can be either a person or an organization, can belong to

one or more address books.

A legal entity is an organization that has a registered or legislated legal structure. Legal entities can enter into

legal contracts and are required to prepare statements that report on their performance.

A company is a type of legal entity. Currently, companies are the only kind of legal entity that you can create, and

every legal entity is associated with a company ID. This association exists because some functional areas in the

program use a company ID, or DataAreaId, in their data models. In these functional areas, companies are used as

a boundary for data security. Users can access data only for the company that they are currently logged on to.

An operating unit is an organization that is used to divide the control of economic resources and operational

processes in a business. People in an operating unit have a duty to maximize the use of scarce resources,

improve processes, and account for their performance.

The types of operating units include cost centers, business units, value streams, departments, and commerce

channels. The following table provides more information about each type of operating unit.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/organizations-organizational-hierarchies.md


Department An operating unit that represents a
category or functional part of an
organization that performs a specific
task, such as sales or accounting.

Used to report on functional areas. A
department may have profit and loss
responsibility, and may consist of a
group of cost centers.

Commerce channel An operating unit that represents a
brick and mortar store, an online store
or an online marketplace.

Used for the management and
operational control of one or more
stores within or across legal entities.
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TeamsTeams

Organizational hierarchies

NOTENOTE

A team is an organization in which the members share a common responsibility, interest, or objective. Teams

cannot be used in organizational hierarchies.

Set up organizational hierarchies to view and report on your business from different perspectives. For example,

you can set up a hierarchy of legal entities for tax, legal, or statutory reporting. Set up a hierarchy that is based

on operating units to report financial information that is not legally required, but that is used for internal

control. For example, you can create a purchasing hierarchy to control purchasing policies, rules, and business

processes.

Each hierarchy is assigned a purpose. The purpose of a hierarchy determines the types of organizations that can

be included in the hierarchy. The purpose also determines which application scenarios a hierarchy can be used

in.

Organizations in a hierarchy can share parameters, policies, and transactions. An organization can inherit or

override the parameters of its parent organization. However, shared master data, such as products and address

books, applies to the whole organization and cannot be overridden for individual organizations. Creating

organizations and hierarchies requires careful planning. For more information, see Plan your organizational

hierarchy.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

Decide whether to model internal organizations as legal entities or
operating units

Master dataMaster data

Before you set up organizations and organization hierarchies, make sure that you plan how your business will

be modeled. The organization model has a significant effect on the implementation and business processes.

Organizational hierarchies represent the relationships between the organizations that make up a business.

Therefore, the most important consideration when you model organizations is the structure of your business.

We recommend that you define organization structures based on feedback from executives and senior

managers from functional areas, such as finance and accounting, human resources, operations, purchasing, and

sales and marketing.

When you are planning hierarchies, it is also important to consider the relationship between the organizational

hierarchy and financial dimensions. You can set up multiple organizational hierarchies to represent different

views of your business. By using financial dimensions, you can create reports based on these views. Work with

your partner to create hierarchies that address both organizational and statutory reporting needs.

Although you can use financial dimensions to represent legal entities without creating the legal entities, financial

dimensions aren't designed to address the operational or business needs of legal entities. The interunit accounting

functionality is designed to address only the accounting entries that are created by each transaction.

You shouldn't decide how to model organizations based only on the information in this article. This documentation is a

guide. You can work with your Partner for additional guidance. Your Partner has gained experience in various industries

and across the customer base.

You must have at least one legal entity to represent your business. A legal entity can enter legal contracts and is

required to prepare financial statements that report on its performance.

Legal entities can be used for transactional business or for consolidation. This means that a legal entity in

Finance and Operations does not necessarily represent a real entity in your business. For example, a company

that participates in transactions can own subsidiary legal entities. In this scenario, a legal entity is required for

transactions, and a virtual legal entity is required to consolidate the results and balances of the subsidiary legal

entities.

Internal organizations in your business, such as regional offices, can be represented as additional legal entities,

or as operating units of the main legal entity. An operating unit is not required to be a legally defined

organization. Operating units are used to control economic resources and operational processes in the business.

For example, departments and cost centers are operating units.

Some functionality works differently depending on whether the organization is a legal entity or an operating

unit. Carefully consider the functionality described below as you make your decision.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/plan-organizational-hierarchy.md


If the organization is modeled as a legal entityIf the organization is modeled as a legal entity

If the organization is modeled as an operating unitIf the organization is modeled as an operating unit

Module parametersModule parameters
If the organization is modeled as a legal entityIf the organization is modeled as a legal entity

If the organization is modeled as an operating unitIf the organization is modeled as an operating unit

Data securityData security
If the organization is modeled as a legal entityIf the organization is modeled as a legal entity

If the organization is modeled as an operating unitIf the organization is modeled as an operating unit

LedgersLedgers
If the organization is modeled as a legal entityIf the organization is modeled as a legal entity

If the organization is modeled as an operating unitIf the organization is modeled as an operating unit

Fiscal calendarsFiscal calendars
If the organization is modeled as a legal entityIf the organization is modeled as a legal entity

If the organization is modeled as an operating unitIf the organization is modeled as an operating unit

ConsolidationConsolidation
If the organization is modeled as a legal entityIf the organization is modeled as a legal entity

Some master data, such as customers, payment terms, tax authorities, and site-specific stock ordering, must be

set up for each legal entity. Some master data, such as users, products, and most human resources data, is

shared among all legal entities.

Master data is shared among operating units.

Parameters for modules, such as Accounts receivable parameters, Accounts payable parameters, and Cash and

bank management parameters, must be set per legal entity. Because the module setup for legal entities is

separate, each subsidiary can comply with local statutory requirements and business practices. For example, a

professional services legal entity and a manufacturing legal entity can have different module parameters even

though they report to the same parent company.

Module parameters are shared among operating units.

Most data is automatically secured by company ID. A company ID is a unique identifier for the data that is

associated with a legal entity. A company can be associated with only one legal entity, and a legal entity can be

associated with only one company. Users can access data only for the companies that they have access to. You

do not need to customize to secure data by company ID.

Data can be secured per operating unit by creating customized data security policies. Data security policies are

used to limit access to data. For example, assume that a user is allowed to create purchase orders only in a

particular operating unit. Data security policies can be created to prevent the user from accessing purchase

order data from any other operating unit. The volume of transactions and the number of security policies can

affect performance. When you design security policies, keep performance in mind.

Each legal entity requires a ledger that provides a chart of accounts, accounting currency, reporting currency,

and fiscal calendar. A balance sheet can be created only for a legal entity. Main accounts, dimensions, account

structures, charts of accounts, and account rules can be used by more than one legal entity.

An operating unit can't have its own ledger information. If your internal organizations do not require unique

ledgers, you can model them as operating units. Ledger information will be set up for the parent legal entity in

the hierarchy. Income statements can be created for operating units within a legal entity or for the parent legal

entity.

Each legal entity has its own fiscal calendar. If your internal organizations use different fiscal years and fiscal

calendars, you must model the organizations as legal entities.

Operating units must share a fiscal calendar. If your internal organizations can use the same fiscal years and

fiscal calendars, you can model the organizations as operating units.

You must consolidate the financial results for regional offices into a single, consolidated company in order to



If the organization is modeled as an operating unitIf the organization is modeled as an operating unit

Centralized paymentsCentralized payments
If the organization is modeled as a legal entityIf the organization is modeled as a legal entity

If the organization is modeled as an operating unitIf the organization is modeled as an operating unit

Intercompany transactionsIntercompany transactions
If the organization is modeled as a legal entityIf the organization is modeled as a legal entity
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If the organization is modeled as an operating unitIf the organization is modeled as an operating unit
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Local tax requirementsLocal tax requirements
If the organization is modeled as a legal entityIf the organization is modeled as a legal entity

prepare financial statements.

Consolidation is not required, because data is already shared among operating units.

Centralized payments must be set up so that invoices for all child legal entities can be paid to or from a single

parent legal entity.

Centralized payments are not required because all invoices are recorded in a single legal entity.

Intercompany sales orders, purchase orders, payments, or receipts can be applied to one another. You are not

required to use journal vouchers. You can view intercompany transactions at the sub-ledger level (Accounts

receivable, Accounts payable). The following examples illustrate how intercompany transactions are handled.

If you model the regional office as a legal entity, you have the following options:

Headquarters creates a journal entry to cross-charge the regional office for the expense. The transactions

cannot be aged.

Headquarters sends a purchase order for the services to the regional office. A sales order is automatically

created in the legal entity for the regional office, with intercompany sub-ledger transactions.

If you model the regional office as a legal entity, you have the following options:

The invoice and payment follow the regulatory requirements of headquarters. Headquarters can create a

journal entry to cross-charge the regional office for the expense. The transactions cannot be aged.

The invoice and payment follow the regulatory requirements of headquarters. Headquarters can create an

intercompany sub-ledger transaction.

Intercompany transactions among operating units are supported only through journal vouchers. An operating

unit cannot issue or receive a purchase order, sales order, or invoice from another operating unit in the same

legal entity. You cannot view intercompany transactions at the sub-ledger level (Accounts receivable, Accounts

payable). The following examples illustrate how intercompany transactions are handled.

If you model the regional office as an operating unit, headquarters enters an expense transaction and codes it to

the regional office.

If you model the regional office as an operating unit, the invoice and payment follow the regulatory

requirements of headquarters. The invoice can be coded to the regional office. On the income statement, use a

balancing financial dimension to report costs for the regional office.

A legal entity is subject to the tax laws of the tax authority in the country/region where the legal entity is

registered. For example, a legal entity that is registered in Denmark is subject to Danish tax laws and regulations.

A legal entity can belong to only one country/region. The country/region that you select for the primary address

of the legal entity controls the country/region-specific features that are available to that legal entity. For

example, if the primary address of the legal entity is in Denmark, features that are related to Danish tax laws and

regulations become available. Therefore, if your organizations are in different countries/regions and require
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Statutory reporting for a country/regionStatutory reporting for a country/region
If the organization is modeled as a legal entityIf the organization is modeled as a legal entity
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If the organization is modeled as an operating unitIf the organization is modeled as an operating unit

CurrencyCurrency
If the organization is modeled as a legal entityIf the organization is modeled as a legal entity

If the organization is modeled as an operating unitIf the organization is modeled as an operating unit

Year-end closingYear-end closing
If the organization is modeled as a legal entityIf the organization is modeled as a legal entity

If the organization is modeled as an operating unitIf the organization is modeled as an operating unit

Number sequencesNumber sequences
If the organization is modeled as a legal entityIf the organization is modeled as a legal entity

If the organization is modeled as an operating unitIf the organization is modeled as an operating unit

different local tax options, you must set up the organizations as separate legal entities.

Operating units use the country context of the parent legal entity. Operating units in the same legal entity

cannot have different country/region-specific requirements. If your organizations are in the same

country/region and use the same tax options, you can set them up as operating units.

For countries/regions that are supported, most statutory reports can be created. For information about which

reports are available for each country/region, see the Microsoft Dynamics Localization Portal. (A

CustomerSource logon is required.)

A posting layer in the general ledger allows you to make adjusting entries to a parent company that uses a different

accounting standard than the child company. For example, for a company that uses generally accepted accounting

practices in the United Kingdom (UK GAAP), you can make adjusting entries in the posting layer. These entries can be

consolidated into a parent company that uses generally accepted accounting principles (GAAP) in the United States. The

adjusting entries do not affect UK GAAP reporting.

Statutory reports must be created by using another application. You must ensure that data is captured in

Finance and Operations apps to support the requirements of each operating unit, where they differ from the

requirements of headquarters.

If your organizations must use different functional currencies, you must model the organizations as legal

entities. Functional currencies are set up per legal entity. However, you can enter transactions in multiple

currencies.

If your organizations can use a single functional currency, you can model the organizations as operating units.

Operating units must share a functional currency. However, you can enter transactions and create reports in

multiple currencies.

If laws and accounting practices differ among the countries/regions where your organizations are located, you

may require different year-end procedures per organization. This means that you must model the organizations

as legal entities. Each legal entity has its own year-end procedures.

If laws and accounting practices are the same among the countries/regions where your organizations are

located, you may use a single set of year-end procedures. This means that you can model the organizations as

operating units. All operating units must use the same year-end closing procedure.

Number sequences for some references can be set up per legal entity. Some number sequences can be shared.

Number sequences for some references can be set up per operating unit. Some number sequences can be

shared.

https://docs.microsoft.com/en-us/dynamics/s-e/
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If the organization is modeled as an operating unitIf the organization is modeled as an operating unit

Inquiry and reportingInquiry and reporting
If the organization is modeled as a legal entityIf the organization is modeled as a legal entity

If the organization is modeled as an operating unitIf the organization is modeled as an operating unit

Best practices for modeling organizations and hierarchies

Product definitions are shared, and they must be released to individual legal entities before they can be included

in transactions. Each legal entity has its own set of released products that can be included in transaction

documents. If your internal organizations must use different sets of products, you must model the organizations

as legal entities.

Even though product definitions are shared, in each legal entity where a product has been released, you can specify

different sales, purchase, and stocking parameters for the item at each inventory site.

All operating units share the same set of products. If your internal organizations can share the same set of

products, you can model the organizations as operating units.

You must manually change companies to enter transactions and perform inquiries in multiple legal entities.

Because of data security boundaries, consolidated inquiry and reporting can be resource intensive and time-

consuming.

You do not need to change companies to access data from multiple operating units. Consolidated inquiry and

reporting and individual regional inquiry is easier and faster.

Consider the following best practices when you implement an organization hierarchy:

Create a department to model the intersection between a legal entity and a business unit. You can then roll

up data from a department to a legal entity for statutory reporting, and from a department to a business unit

for internal reporting. Departments can serve as profit centers. If you use departments, you do not have to

use legal entities and business units as dimensions in the account structure. You can use just departments as

a dimension. However, you must use both cost centers and departments as dimensions in the account

structure if cost centers are used only as cost accumulators, and departments are used for revenue

recognition.

Model multiple hierarchies for operating units if you have complex requirements for reporting profit and

loss.

In a single legal entity, do not model multiple hierarchies for the same hierarchy purpose.

Do not create a hierarchy for every purpose. Usually, you can use one hierarchy for multiple purposes. For

example, one hierarchy of operating units can be assigned to all policy-related purposes.

Create balanced hierarchies. In a hierarchy, all nodes that are the same distance from the root node are

defined as a level. In a balanced hierarchy, only one type of operating unit can occur at each level, and the

distance from the root node to each level is consistent. If there are intermediate levels between a department

and a legal entity or a business unit, placeholder organizations may be required to create a balanced

hierarchy.

Do not model a separate hierarchy of operating units if the structure for legal entities is also your operating

structure. A mixed hierarchy of legal entities and operating units may serve both purposes.

Before you model major restructuring scenarios, use the hierarchy's effective dates to perform an impact

analysis and a validation test.

Use draft mode to change a hierarchy before you publish a new version in a production environment.

Limit the number of people who have permissions to add or remove organizations from a hierarchy in a
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production environment. A smaller number reduces the chance that costly mistakes can occur and

corrections must be made.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Create a hierarchy

Add organizations to the hierarchy
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Use the following procedure to create an organizational hierarchy. You can use organizational hierarchies to

view and report on your business from various perspectives. For example, you can set up one hierarchy for tax,

legal, or statutory reporting. You can then set up another hierarchy to report financial information that is not

legally required, but that is used for internal reporting.

Before you create an organizational hierarchy, you must create organizations. For more information, see the

"Create a legal entity" or "Create an operating unit" tasks. You can also create departments and teams.

The demo data company used to create this procedure is USMF.

1. Go to Navigation pane > Modules > Organization administration > Organizations >Navigation pane > Modules > Organization administration > Organizations >

Organization hierarchiesOrganization hierarchies .

2. On the Action paneAction pane, click NewNew .

3. In the NameName field, type a value.

4. In the PurposePurpose section, click Assign purposeAssign purpose.

5. In the list, find and select the desired record. Select a purpose to assign to your organization hierarchy.

6. In the Assigned hierarchiesAssigned hierarchies  section, click AddAdd.

7. In the list, mark the selected row. Find the hierarchy you just created.

8. Click OKOK.

1. In the list, find and select the desired record. Select your hierarchy.

2. In the Assigned hierarchiesAssigned hierarchies  section, click View hierarchyView hierarchy .

Add organizations, as necessary.

To add an organization, click EditEdit and then Inser tInser t to add the organization. When you are done

making changes you can SaveSave a draft and/or PublishPublish the changes.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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A legal entity is an organization that is identified through registration with a legal authority. Legal entities can

enter into contracts and are required to prepare statements that report on their performance. The following

procedure explains how to create a legal entity. The demo data company used to create this procedure is USMF.

1. Go to Navigation pane > Modules > Organization administration > Organizations > LegalNavigation pane > Modules > Organization administration > Organizations > Legal

entitiesentities .

2. Click NewNew .

3. In the NameName field, type a value.

4. In the CompanyCompany  field, type a value.

5. In the Countr y/regionCountr y/region field, enter or select a value.

6. Click OKOK. In the GeneralGeneral  section, provide the following general information about the legal entity: Enter a

search name, if a search name is required. A search name is an alternate name that can be used to search for

this legal entity. Select whether this legal entity is being used as a consolidation company. Select whether this

legal entity is being used as an elimination company.

7. Expand the AddressesAddresses  section. In the AddressesAddresses  section, click EditEdit to enter address information, such as the

street name and number, postal code, and city.

8. Expand the Contact informationContact information section. In the Contact informationContact information section, enter information about

methods of communication, such as email addresses, URLs, and telephone numbers.

9. Expand the Statutor y repor tingStatutor y repor ting section. In the Statutor y repor tingStatutor y repor ting section, enter the registration

numbers that are used for statutory reporting.

10. Expand the Registration numbersRegistration numbers  section. In the Registration numbersRegistration numbers  section, enter any information

required by the legal entity.

11. Expand the Bank account informationBank account information section. In the Bank account informationBank account information section, enter bank

accounts and routing numbers for the legal entity.

12. Expand the Foreign trade and logisticsForeign trade and logistics  section. In the Foreign trade and logisticsForeign trade and logistics  section, enter

shipping information for the legal entity.

13. Expand the Number sequencesNumber sequences  section. In the Number sequencesNumber sequences  section, you can view the number

sequences that are associated with the legal entity.

14. Expand the ImagesImages  section. In the ImagesImages  section, view or change the logo and/or dashboard image that

are associated with the legal entity.

15. Expand the Tax registrationTax registration section. In the Tax registrationTax registration section, enter the registration numbers that

are used to report to tax authorities.

16. Expand the Tax 1099Tax 1099  section. In the Tax 1099Tax 1099  section, enter 1099 information for the legal entity.

17. Click SaveSave.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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An operating unit is an organization that is used to divide the control of economic resources and operational

processes in a business. People in an operating unit have a duty to maximize the use of scarce resources,

improve processes, and account for their performance. The types of operating units include cost centers,

business units, departments, and value streams. Use the following procedure to create an operating unit. The

demo data company used to create this procedure is USMF.

1. Go to Navigation pane > Modules > Organization administration > Organizations > OperatingNavigation pane > Modules > Organization administration > Organizations > Operating

units.units.

2. Click NewNew  to open the drop dialog.

3. In the list, find and select the desired record. Select the type of operating unit you want to create.

4. In the list, click the link in the selected row.

5. In the NameName field, type a value.

6. Optionally, change the Operating unit numberOperating unit number  as needed. Note that this number is a unique idenitifier for

the correspondng Par tyPar ty  record and cannot be the same as any other operating unit.

7. Select SaveSave.

Expand the GeneralGeneral  section, if necessary.

Provide general information about the operating unit, such as an identification number, DUNS

number, and manager.

Expand the AddressesAddresses  section, if necessary.

Enter address information, such as the street name and number, postal code, and city. Click AddAdd to

enter a new address record, or click Edit to modify an existing address record.

Expand the Contact informationContact information section, if necessary.

Enter information about methods of communication, such as email addresses, URLs, and telephone

numbers. To enter a new communication record, click New. To modify an existing communication

record, click More options > AdvancedMore options > Advanced.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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How the global address book works

Party rolesParty roles

The global address book is a centralized repository for master data that must be stored for all internal and

external persons and organizations that the company interacts with. The data that is associated with party

records includes the party's name, address, and contact information. Other details vary, depending on whether

the party is a person or an organization. Each party record is assigned to a party, and each party can be

associated with one or more party roles in a company. Party roles include customer, prospect, worker, user,

vendor, competitor, applicant, and contact. For example, the organization party First Up Consultants, can be

associated with customer, business relation, and vendor roles in the CEE company, and can also be associated

with the vendor role in the CEU company. Here are some of the benefits of this shared data:

The data shows the relationships that people and organizations have with other areas of the company. The

relationship between two organizations changes when one organization has multiple roles, such as vendor

and customer. Communication between the two organization also changes. There might be special

agreements that can be negotiated to encourage a closer partnership with the other organization.

Setup and maintenance are easier. For example, when an address changes, the update must be made in only

one place. All the other associated records are updated automatically.

The following illustration shows how party records, party roles, locations, and transactions interact and relate to

an address book. As the illustration shows, a party record can belong to one or more address books. Each party

record can store one or more locations, or addresses, and is assigned a party role. The role that is assigned to

the party record can have specific transactions types associated with it. The following sections provide more

information about party roles, locations, and transaction types. The following image is a graphical

representation of the ways that parties, party roles, locations, and transactions interact in relation to the global

address book.

Roles that are associated with party records are referred to as party roles. There are several party roles, and

they can be assigned to both party types, person and organization. Here are the definitions for each party role:

CustomerCustomer  – Individuals, companies, or other entities who purchase goods and services that are produced by

other individuals, companies, or entities.

ProspectProspect – A party that might provide a service or benefit to a legal entity.

WorkerWorker  – A person who assumes the role of an employee or a contractor, and who is paid in exchange for

services.

UserUser  – A person who is a user of the system.

VendorVendor  – A party that supplies products to one or more legal entities in exchange for payment.

CompetitorCompetitor  – A person or organization that provides goods or services that are similar to the goods or

services that your business provides.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/overview-global-address-book.md
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Creating new party recordsCreating new party records

Party roles and transactionsParty roles and transactions

Parties locations, addresses, and contact informationParties locations, addresses, and contact information

Locations and transactionsLocations and transactions
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ApplicantApplicant – A person who makes a formal written or electronic request to work for or fill an open position

in an organization.

ContactContact – A person, either inside or outside your organization, that you have created an entry for. In this

entry, you can save information such as the person's street and email addresses, telephone and fax numbers,

and webpage URLs.

There are two ways to enter party records in the global address book:

Creating a par ty record when you don't know the roleCreating a par ty record when you don't know the role – When you create a party record and don't

know the role type (for example, you don't know whether the party is a customer or an opportunity), you

create the record in the global address book. You can select the role type later.

Creating a par ty record when you know the roleCreating a par ty record when you know the role – If you know the role type for the party, you can

create a record on the appropriate page for that type. For example, if the party is a customer, you create a

record on the CustomerCustomer  page. When you create and save a record by using the page for the party's role

type, the record is automatically created in the global address book.

For transactions that are a part of the business processes, multiple parties might be associated with each

transaction. An example is a customer that needs to be referenced on project quotations.

Each party record's addresses, locations, and contact information are shared across all the party roles that

are associated with that party. Therefore, when any of this information is changed, all other associated records

are updated accordingly.

When a party role is included in a transaction, the location, address, or contact information of the party can be

accessed when transaction details are entered.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Global address book

Additional address books

This topic describes the considerations and decisions that you must make during the planning process, before

you set up and configure the global address book and any additional address books. Some of the decisions will

require that you confirm the decisions that have been made for other areas of the product, such as the

organization hierarchy.

Before you begin to work with the global address book, you must determine the default values for it. These

default values are then used for any additional address books that you create.

DecisionsDecisions

What sequence should names be displayed in for party records of the PersonPerson type? For example, one

sequence is last name, middle name, first name.

Should party records be deleted from the address book when the role record is deleted? For example, if a

customer record is deleted, should the party record also be deleted?

When a new record is created, should users be notified if a duplicate record is found in the global address

book?

Should the Data Universal Numbering System (DUNS) number be included in a party record's information?

If the DUNS number is included in a party record, should the uniqueness of the number be checked?

When a party record is created in the global address book, do you want a default party type, person, or

organization?

Which user roles should have access to the private addresses and contact information of party records?

After you create the global address book, you can create additional address books as you require, such as a

separate address book for each company in your organization or for each line of business. For example,

Fabrikam is an international organization that has multiple companies and multiple lines of business. Fabrikam

plans to create an address book for each line of business. For lines of business that occur in more than one

location, such as the pneumatic tools business, Fabrikam plans to create an address book for each location.

Chris, the IT manager at Fabrikam, has created the following list of address books that are required. This list also

describes the party records that each address book must include.

Public Sector Contracts (PubSC)Public Sector Contracts (PubSC)  – Party records for all parties that are involved in the public sector

contracts that Fabrikam holds.

Pr ivate Sector Contracts (Pr iSC)Pr ivate Sector Contracts (Pr iSC)  – Party records for all parties that are involved in the private sector

contracts that Fabrikam holds.

Electronic Tools (ET)Electronic Tools (ET)  – Party records for all parties that are involved in the purchase or sale of electronic

tools, or that otherwise interact with the electronic tools that are provided by or purchased for Fabrikam in

the Fabrikam-Japan company.

Pneumatic Tools (PTJPN)Pneumatic Tools (PTJPN)  – Party records for all parties that are involved in the purchase or sale of

pneumatic tools, or that otherwise interact with the pneumatic tools that are provided by or purchased for

Fabrikam in the Fabrikam-Japan company.
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Pneumatic Tools (PTUSA)Pneumatic Tools (PTUSA)  – Party records for all parties that are involved in the purchase or sale of

pneumatic tools, or that otherwise interact with the pneumatic tools that are provided by or purchased for

Fabrikam in the Fabrikam-US company.

Decision:Decision:

How many additional address books will you create?

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Use this procedure to set the default values and security policies for the global address book.

The demo data company used to create this task is USMF. This task is intended for the Planning and

configuration team.

1. In the Navigation pane, go to Modules > Organization administration > Global address book >Modules > Organization administration > Global address book >

Global address book parametersGlobal address book parameters .

2. In the Name sequenceName sequence field, select how names should be shown.

3. In Delete par ties with no rolesDelete par ties with no roles , select whether to delete parties with that have not been assigned a role.

4. In Use duplicate checkUse duplicate check , select whether to check for duplicate records.

5. In Display DUNS number on addressesDisplay DUNS number on addresses , select whether to display the DUNS number on addresses.

6. In Check for unique DUNS numberCheck for unique DUNS number , select whether to check for unique DUNS numbers.

7. In the Par tyPar ty  field, select an option.

8. In the CustomerCustomer  field, select an option.

9. In the VendorVendor  field, select an option.

10. In the ProspectProspect field, select an option.

11. In the CompetitorCompetitor  field, select an option.

12. Click the Pr ivate location securityPr ivate location security  tab.

13. In the list, find and select the desired record. Press the Shift key to select multiple roles to add to the

Selected rolesSelected roles  pane and then click the arrow to add the selected roles.

14. Click SaveSave.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/tasks/configure-global-address-book.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Address books FAQ
2/18/2021 • 5 minutes to read • Edit Online

How do I check for duplicate records?

Can I bulk add or delete party records from an address book?

Can I change the party type of a record, or do I have to delete the old
record and create a new one?

How do I change the name or address of a party record?

Can I merge two or more party records into one record?

You can check for duplicate records directly from the Global address bookGlobal address book list page. On the Action Pane, on

the Par tyPar ty  tab, in the MaintainMaintain group, click Check for duplicatesCheck for duplicates . Then select the values to include in the check

for duplicates.

Yes, you can add multiple party records to an address book and also remove multiple party records.

To add multiple party records to an address book, on the Global address bookGlobal address book list page, select the parties

in the list. Then, on the Action Pane, on the Par tyPar ty  tab, in the MaintainMaintain group, click Assign par tiesAssign par ties . Select

the address books to add the selected party records to, and then click OKOK. All the selected party records are

added to the address books that you selected.

To remove multiple party records from an address book, on the Global address bookGlobal address book list page, select the

parties in the list. Then, on the Action Pane, on the Par tyPar ty  tab, in the MaintainMaintain group, click Remove par tiesRemove par ties .

Select the address books to remove the parties from, and then click OKOK. All the selected party records are

removed from the address books that you selected.

Occasionally, you might have to change the party type of a record from person to organization or from

organization to person. For example, Nancy is a member of the sales team for Fabrikam U.K. At a trade show in

London, she meets six new prospects. Nancy creates a prospect party record for each prospect. When Nancy

saves the records, each record is also created in the global address book. Fabrikam has set the default party type

to organization, but two of the new prospects should have a record type of person. Therefore, when Nancy

returns from the trade show, she must change the party type of the two prospect records. To change a party

record from one party type to another, you must first create a new party record of the correct type in the global

address book. You then associate the old party record with this new record. After you have made the new party

association, delete the original party record that has the incorrect record type.

You can update the name of a party record, and the addresses that are associated with that record, at any time.

To update the name of a party record, open the party record, and then, on the Action Pane, click EditEdit. On the

GeneralGeneral  FastTab, enter the new name for the party, and then save the record.

To update an address for a party record, open the party record, and then, on the AddressesAddresses  FastTab, select

the address to update. Click EditEdit, and then, on the Edit addressEdit address  page, make the required changes to the

address or address parameters.

Occasionally, you might want to merge two or more party records into a single record. This can occur if you

create one or more duplicate party records, either on purpose or unintentionally. When you merge party

records, you select one record to keep. The information from the other records is then merged into this record.
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Can I translate address information for party records?

NOTENOTE

For example, you discover that information about Fabrikam is stored in three party records: A, B, and C. You

decide to keep party record A. Therefore, the information that is stored in party records B and C will be merged

into party record A. There are some situations where you can't merge party records:

You can't merge party records that are associated with the same party role, such as customer or vendor, in

the same legal entity. For example, party A is associated with a customer in legal entity 123, and party B is

associated with a different customer in legal entity 123. These party records can't be merged, because if they

were merged, the merged party record would be associated with multiple customers in the same legal entity,

and this isn't allowed. However, the records can be merged if party B is associated with a vendor in legal

entity 123 or with a customer in a different legal entity.

You can't merge internal party organization records in the same legal entity, team, or operating unit.

You can enter party records either in the global address book or on the appropriate entity page. When you add a

record in one location, the same record is always added in the other location. For example, if you add a party

record for a customer in the global address book, the record is also added on the CustomerCustomer  page. Likewise, if

you add a party record for a customer on the CustomerCustomer  page, the record is also added in the global address

book. Use the following guidelines to decide where you should enter new party records:

Creating a par ty record when you don't know the entity typeCreating a par ty record when you don't know the entity type – If you must create a party record but

don't know the entity type (for example, you don't know whether the entity is a customer or an opportunity),

create the record in the global address book. You can select the entity type later.

Creating a par ty record when you know the entity typeCreating a par ty record when you know the entity type – If you know the entity type for the party,

you can create a record on the applicable page for that type. For example, create a record for a customer on

the CustomerCustomer  page. When you create and save a record by using the appropriate entity page, the record is

automatically created in the global address book.

You can set up translations of address information, so that the information appears in your user language

(system language) in your program, but in another language on documents such as sales orders. You can enter

translations for country/region names, address purposes, and name sequences. For example, your system

language is Danish, and you create a sales order for a customer in France. In this case, you can view the

customer record in Danish in the program but display the address information in French on the printed sales

order. When you set up translations, you should enter a translation for every item in the list. Any item that you

don't enter a translation for will appear in the system language. For example, your system language is Danish,

and you send a document to a customer in Spain. If you haven't entered Spanish (ESP) translations for the

address information, that information will appear in Danish both in the program and on the printed document.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Configure address books

NOTENOTE

Use this procedure, and the decisions that you made in the Planning the configuration of the global address

book and additional address books topic, to set up additional address books for your organization.

The demo data company used to create this task is USMF. This recording is intended for the Planning and

configuration team members.

1. In the Navigation paneNavigation pane, go to Modules > Organization administration > Global address book >Modules > Organization administration > Global address book >

Address booksAddress books .

2. Click NewNew .

3. In the NameName field, type a value.

4. In the Descr iptionDescr iption field, type a value.

5. Click SaveSave.

6. In the list, find and select the desired record.

7. Click the arrow to add the selected available teams to the address book.

8. Click SaveSave.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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What is workflow?

Workflow is a systemWorkflow is a system

Workflow is a business processWorkflow is a business process

This topic describes the workflow system.

The term workflow can be defined in two ways: as a system and as a business process.

Workflow is a system that runs on the Application Object Server (AOS). The workflow system provides

functionality that you can use to create individual workflows, or business processes.

A workflow represents a business process. It defines how a document flows, or moves, through the system by

showing who must complete a task, make a decision, or approve a document. For example, the following

illustration shows a workflow for expense reports.

To better understand this workflow, suppose that Sam submits an expense report for USD 7,000. In this scenario,

Ivan must review the receipts that Sam routes to him. Then Frank and Sue must approve the expense report.
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Workflow content
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Now suppose that Sam submits an expense report for USD 11,000. In this scenario, Ivan must review the

receipts, and Frank, Sue, and Ann must approve the expense report.

There are several benefits of using the workflow system in your organization:

Consistent processesConsistent processes  – You can define how specific documents, such as purchase requisitions and expense

reports, are processed. By using the workflow system, you ensure that documents are processed and

approved in a consistent and efficient manner.

Process visibilityProcess visibility  – You can track the status, history, and performance metrics of workflow instances. This

helps you determine whether changes should be made to the workflow to improve efficiency.

Centralized work listCentralized work list – Users can view a centralized work list that displays the workflow tasks and

approvals that are assigned to them.

Workflow system architecture

Workflow elements

Actions in workflow approval processes

Create workflows overview

Configure workflow properties

Configure manual tasks in a workflow

Configure automated tasks in a workflow

Configure approval processes in a workflow

Configure approval steps in a workflow

Configure manual decisions in a workflow

Configure conditional decisions in a workflow

Configure parallel activities in a workflow

Configure parallel branches in a workflow

Configure line-item workflows

Workflow FAQ

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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This article describes the architecture of the workflow system.

The workflow infrastructure consists of two components that are hosted on Application Object Server (AOS): the

X++ workflow runtime and the managed workflow runtime.

The X++ workflow runtime consists of the following components:

Workflow runtime application programming interface (API)

A messaging batch job

A message queue

Either the messaging batch job or the workflow runtime API can invoke the application code, if it's required. The

X++ workflow runtime is compiled into the Common Intermediate Language (CIL) of the Microsoft .NET

Framework.

The managed workflow runtime consists of the Windows Workflow Foundation and Finance and Operations

apps extensions.

Logically, the workflow infrastructure is an extension and is transparent to users. Physically, both the X++

workflow and the managed workflow runtimes are hosted on AOS. The workflow infrastructure uses batch

processing on AOS and .NET Interop to integrate both subsystems, and to pass messages from one subsystem

to the other. The X++ code that is run in the batch processor is compiled to .NET CIL. The batch processing runs

in the .NET common language runtime (CLR).

The following figure shows the high-level architecture of the workflow infrastructure.
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1 X++ workflow runtime A user submits an expense report by
clicking the SubmitSubmit  button on one of
the workflow controls. This action
causes X++ code to activate a
workflow instance by calling the
workflow runtime API. The workflow
runtime API posts a message to the
message queue. The messaging batch
job reads the message and sends a
workflow activation request to the
managed workflow runtime.

[!NOTE] The messaging batch job
processes the message queue at
one-minute intervals.

Users can use workflow pages and controls to participate in business processes.

Developers can create workflows for the objects that they have added. The following table describes the

workflow steps that occur when a user submits an expense report to the workflow system for approval.
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2 Managed workflow runtime .NET Interop from X++ receives the
message and starts a new workflow
instance via Windows Workflow
Foundation. This workflow instance
performs a callback to the X++
workflow runtime API via .NET Interop
to X++ CIL and posts a message that
the workflow has started.

3 X++ workflow runtime The messaging batch job reads the
workflow star tedworkflow star ted message from the
message queue and invokes the
application event handler to process a
workflow star tedworkflow star ted event. The batch
job then posts an acknowledgment
message that the event was processed.

4 Both This same messaging pattern is
repeated, as required, throughout the
lifecycle of the workflow instance.
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After the message is posted, the
managed workflow runtime saves
the idle workflow instance to the
database. The runtime then
removes the workflow instance
from memory. When the managed
workflow runtime receives another
message from the X++ workflow
runtime for this workflow instance,
it restores the workflow instance
to memory and resumes it.

Each workflow instance is unique.
If two users submit their expense
reports for approval, two workflow
instances are started.

The workflow architecture helps provide a reliable and durable messaging system, and also helps guarantee that

the state of the workflow is always synchronized with the state of the application. If an unexpected hardware or

software failure occurs, the workflow instance state is returned to its last known saved point, and the message

stays in the queue. Therefore, from an architecture perspective, the recovery model is to fix the problem and

resume the workflow.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Tasks

Manual taskManual task

Automated taskAutomated task

Approval processes

Line-item workflow elements

This topic describes the various elements that make up a workflow.

A workflow consists of elements. The sections that follow describe each type of element.

A task is a unit of work that must be performed. Two types of tasks can be added to a workflow: manual tasks

and automated tasks.

A manual task is a unit of work that must be performed by a user. For example, an expense report workflow can

have manual tasks that require the assigned users to complete the following actions:

Review the receipts that are submitted together with an expense report.

Call an employee's manager.

An automated task is a unit of work that must be performed by the system. No human interaction is required.

For example, a sales order workflow can have automated tasks that require the system to complete the

following actions:

Perform a credit check.

Create a customer record for the customer, if a record doesn't already exist.

An approval process is a process that consists of separate steps. At each approval step, the user can perform the

following actions:

Approve the document.

Reject the document.

Request a change to the document.

Assign the document to another user for approval.

A workflow can be created to process either documents or the line items on a document. For example, you've

created an approval workflow for timesheets. (We will refer to this workflow as the document workflow.) You

can add a line-item workflow element to that document workflow. When the line-item element is run, each line

item on the document is submitted for processing. You might want all the line items to be processed by the

same line-item workflow, or you might want each line item to be processed by a different line-item workflow.

Imagine that an employee has submitted a timesheet that resembles the following figure.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/workflow-elements.md


Flow-control elements

Manual decisionManual decision

Conditional decisionConditional decision

Parallel activityParallel activity

SubworkflowSubworkflow
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In this scenario, you might want to create the following line-item workflows:

L ine-item workflow 1Line-item workflow 1  – This workflow is used to process line items where the project ID is 1111.

L ine-item workflow 2Line-item workflow 2  – This workflow is used to process line items where the project ID is 2222.

L ine-item workflow 3Line-item workflow 3  – This workflow is used to process line items where the project ID is 3333.

The following elements let you design workflows that have alternate branches or branches that run at the same

time.

A manual decision is a point where a workflow divides into two branches. A user must make a decision, and this

decision determines which branch is used to process the document that was submitted.

A conditional decision is also a point where a workflow divides into two branches. However, the system decides

which branch is used to process the document that was submitted. To make this decision, the system evaluates

the document to determine whether it meets specified conditions.

A parallel activity is a workflow element that includes two or more workflow branches that run at the same time.

A subworkflow is a workflow that runs in the context of another workflow.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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This article explains the actions that each participant in a workflow approval process can take.

A workflow can involve several groups of people: the originator, task assignees, decision makers, and approvers.

For example, in the following expense report workflow, Sam is the originator, the members of the queue are task

assignees, John is a decision maker, and Frank, Sue, and Ann are approvers.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/workflow-actions.md
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Actions that an originator can perform

Actions that a task assignee can perform
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CompleteComplete

RejectReject

DelegateDelegate

Request changeRequest change

The following sections explain the workflow actions that each group can perform.

The originator starts a workflow instance by submitting a document for processing. For example, Sam must click

the SubmitSubmit button on the Expense repor tExpense repor t page to submit his expense report.

A task can be assigned to multiple people or to a work item queue that is monitored by several people. However,

only one person can complete a task. For example, Sam has submitted an expense report and has routed his

receipts to his organization's Expense Reports department for review.

The members of the Adventure Works Expense Reports department monitor the queue. Julie, a member of that

department, has accepted the task of reviewing Sam's expense report and receipts. She can now perform one of

the following actions: complete, reject, delegate, request change, reassign, or release.

The actions that are available vary, depending on how the software developer designed the task.

When a user completes a task, the document that was submitted for processing is assigned to the next user in

the workflow, if there is a next user. If no additional processing is required, the workflow process ends.

For example, Julie, a member of the Adventure Works Expense Reports department, has accepted the task of

reviewing Sam's expense report and receipts. After Julie completes her review, the document is assigned to

John.

When a user rejects a document, the workflow process ends.

For example, Julie, a member of the Adventure Works Expense Reports department, has accepted the task of

reviewing Sam's expense report and receipts. If Julie rejects the expense report, the workflow process ends.

Sam can then resubmit the expense report. He can make changes first, or he can resubmit the original version. If

Sam resubmits the expense report, the workflow process starts at the manual review task.

When a user delegates a task, the task is assigned to another user.

For example, Julie, a member of the Adventure Works Expense Reports department, has accepted the task of

reviewing Sam's expense report and receipts. Julie delegates this task to Tim, who is her assistant.

Tim then acts on behalf of Julie. Therefore, when Tim completes his review, the expense report is assigned to

John, just as if Julie had completed the task.

When a user requests a change to a document that was submitted, the document is sent back to the originator.

For example, Julie, a member of the Adventure Works Expense Reports department, has accepted the task of

reviewing Sam's expense report and receipts. Julie notices some errors on the expense report and requests

changes. The expense report is sent back to Sam.

Sam can resubmit the expense report. He can make the requested changes first, or he can resubmit the original

version. If Sam resubmits the expense report, a member of the work item queue must review the expense report



ReassignReassign

ReleaseRelease

Actions that a decision maker can perform

[Choice 1] or [Choice 2][Choice 1] or [Choice 2]

DelegateDelegate

Actions that an approver can perform

ApproveApprove

and the receipts again.

The members of a work item queue can reassign documents that are in that queue to another queue.

For example, Julie, a member of the Adventure Works Expense Reports department, is monitoring the queue. To

help balance the workload, she can reassign the expense report, and the receipts that are included with it, to

another queue.

Occasionally, a member of a work item queue might accept a task, but then decide that he or she can't complete

the task. In this case, the person who accepted the task can release the document back to the work item queue.

For example, Julie, a member of the Adventure Works Expense Reports department, has accepted the task of

reviewing Sam's expense report and receipts. If Julie decides that she can't complete the task, she can release

the document. The expense report is returned to the queue, so that other members of the Adventure Works

Expense Reports department can complete the task.

Typically, a document is assigned to a decision maker, because there is a question that the decision maker must

answer. The answer to the question is typically YesYes  or NoNo, or TrueTrue or FalseFalse. If the decision maker doesn't select

one of those choices, he or she can delegate the decision.

A decision maker must answer a question that is related to the document. The answer to the question is typically

YesYes  or NoNo, or TrueTrue or FalseFalse. The answer that the decision maker selects determines the workflow branch that is

used to process the document.

For example, Sam's expense report is assigned to John. John must decide whether the information in the

document requires a call to Sam's manager. If John decides that a call is required, the expense report is assigned

to Aretha, who must then call Sam's manager. If John decides that a call isn't required, the expense report is

assigned to Frank for approval.

When a decision maker delegates a decision, the document is assigned to another user who must make the

decision.

For example, Sam's expense report is assigned to John. John delegates the decision to Maria, who is his

assistant.

Maria then acts on behalf of John. If Maria decides that a call to Sam's manager is required, the expense report is

assigned to Aretha, who must then call Sam's manager. If Maria decides that a call isn't required, the expense

report is assigned to Frank for approval.

When a document is assigned to an approver, the approver can perform one of the following actions: approve,

reject, delegate, or request change.

When an approver approves a document, the document is assigned to the next user in the workflow, if there is a

next user. If no additional processing is required, the workflow process ends.

For example, Sam has submitted an expense report for USD 6,000, and this document is assigned to Frank.

When Frank approves the document, it's assigned to Sue for approval. When Sue approves the expense report,



RejectReject

DelegateDelegate

Request changeRequest change
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the workflow process ends.

When an approver rejects a document, the workflow process ends.

For example, Sam has submitted an expense report for USD 12,000, and this document is assigned to Sue. If Sue

rejects the expense report, the workflow process ends.

Sam can resubmit the expense report. He can make changes first, or he can resubmit the original version of the

expense report. If Sam resubmits the expense report, the workflow process starts at the approval process.

When an approver delegates a document, the document is assigned to another user for approval.

For example, Sam has submitted an expense report for USD 12,000, and this document is assigned to Frank.

Frank delegates the expense report to Ann.

Ann then acts on behalf of Frank. Therefore, when Ann approves the document, it's assigned to Sue for approval,

just as if Frank had approved it. After Sue approves the document, it's sent to Ann for approval.

When an approver requests a change to a document, the document is sent back to the originator.

For example, Sam has submitted an expense report for USD 12,000, and this document is assigned to Sue. If Sue

requests a change, the expense report is sent back to Sam.

Sam can resubmit the expense report. He can make the requested changes first, or he can resubmit the original

version of the expense report. If Sam resubmits the expense report, it's sent to Frank for approval, because

Frank is the first approver in the approval process.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Open the workflow editor

Drag workflow elements onto the canvas

Connect the elements

Configure the properties of the workflow

Configure the elements of the workflow

This topic explains how to create a workflow.

The module that you're working in determines the types of workflow that you can create. Follow these steps to

select the type of workflow to create and open the workflow editor.

1. Open the module that you want to create a new workflow for. For example, to create a workflow for purchase

requisitions, click Procurement and sourcingProcurement and sourcing.

2. Click SetupSetup > [Module name] workflows[Module name] workflows .

3. On the list page that appears, on the Action Pane, click NewNew .

4. On the Create workflowCreate workflow  page, select the type of workflow to create, and then click Create workflowCreate workflow . The

workflow editor appears. You can now use the following procedures to design the workflow.

The Workflow elementsWorkflow elements  area of the workflow editor contains the elements that you can add to your workflow.

To add elements to the workflow, drag them onto the canvas.

To connect one workflow element to another, hold the pointer over an element until connection points appear.

Click a connection point, and drag it to another element. Be sure to connect all the elements.

Follow these steps to configure the properties of the workflow.

1. Click the canvas to make sure that no workflow element is selected.

2. Click Proper tiesProper ties  to open the Proper tiesProper ties  page for the workflow.

3. Follow the procedures in the Configure workflow properties topic.

Configure each element that you dragged onto the canvas. For information about how to configure each

workflow element, see the following topics:

Configure manual tasks in a workflow

Configure automated tasks in a workflow

Configure approval processes in a workflow

Configure approval steps in a workflow

Configure manual decisions in a workflow

Configure conditional decisions in a workflow

Configure parallel branches in a workflow

Configure a parallel branch

Configure line-item workflows
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Resolve any errors or warnings

Save and activate the workflow

NOTENOTE

The Errors and warningsErrors and warnings  pane at the bottom of the workflow editor shows messages that have been

generated for the workflow. To find the element where an error or warning occurred, double-click the error or

warning message. You must resolve all errors and warnings before you can make the workflow active.

When you're ready to save and activate the workflow, follow these steps.

1. Click Save and closeSave and close to close the workflow editor and open the Save workflowSave workflow  page.

2. Enter comments about the changes that you've made to the workflow, and then click OKOK.

3. If all errors and warnings have been resolved, the Activate workflowActivate workflow  page appears. Select one of the

following options:

To activate this version of the workflow, click Activate the new versionActivate the new version. When a workflow is active,

users can submit documents to it for processing.

If you don't want to activate this version, click Do not activate the new versionDo not activate the new version. You can activate

the workflow later.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Name the workflow

Specify the workflow owner

Select an email template

Enter instructions for users

This topic explains how to configure the various properties of a workflow.

To configure the properties of a workflow, open the workflow in the workflow editor. Click the canvas of the

workflow editor, and then click Proper tiesProper ties  to open the Proper tiesProper ties  page. You can then use the following

procedures to configure the various properties of the workflow.

Follow these steps to enter a name for the workflow.

1. In the left pane, click Basic SettingsBasic Settings .

2. In the NameName field, enter a unique name for the workflow. For example, if you create a purchase requisition

workflow for each country/region that you operate in, you can name the purchase requisition workflow

Purchase Requisitions DenmarkPurchase Requisitions Denmark or Purchase Requisitions SpainPurchase Requisitions Spain .

The workflow owner is the person who manages and maintains the workflow. Follow these steps to specify the

workflow owner.

1. In the left pane, click Basic SettingsBasic Settings .

2. In the OwnerOwner  list, select the name of the person who will manage the workflow.

Follow these steps to select the email template that is used to generate notification messages about the

workflow.

1. In the left pane, click Basic SettingsBasic Settings .

2. In the Email template for workflow notificationsEmail template for workflow notifications  list, select the template.

You can provide instructions to users who submit documents for processing and approval. These users are also

referred to as originators. For example, you're creating a purchase requisition workflow, and you enter

instructions. Those instructions can then be viewed by users who enter purchase requisitions on the PurchasePurchase

requisitionsrequisitions  page. To view instructions, the originator clicks the icon in the workflow message bar. Follow these

steps to enter instructions for users.

1. In the left pane, click Basic SettingsBasic Settings .

2. In the Submission instructionsSubmission instructions  field, enter the instructions.

3. To personalize the instructions, you can insert placeholders. Placeholders are replaced with the

appropriate data when the instructions are shown to users. To insert a placeholder, follow these steps:

a. Click in the Submission instructionsSubmission instructions  field to specify where the placeholder should appear.

b. Click Inser t placeholderInser t placeholder .

c. In the list that appears, select the placeholder to insert.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/configure-workflow-properties.md


NOTENOTE

Specify when this workflow is used through activation conditions

Specify when notifications are sent

d. Click Inser tInser t.

4. To add translations of the instructions, follow these steps:

a. Click TranslationsTranslations .

b. On the page that appears, click AddAdd.

c. In the list that appears, select the language that you will enter the text in.

d. In the Translated textTranslated text field, enter the text.

e. To personalize the text, you can insert placeholders. For instructions about how to enter a placeholder,

see step 3.

f. Click CloseClose.

Placeholders cannot be added using copy and paste because the target information is not pasted in correctly. Use the

interface to add placeholders.

You can create multiple workflows that are based on the same workflow type. When you have multiple

workflows that are based on the same type, you must specify when each workflow is used using activation

conditions. If activation conditions are not met, then the default workflow is used. Similarly, if there is only one

workflow configuration defined for a workflow type, then that workflow configuration will be used regardless of

the activation conditions.

For example, you can create a purchase requisition workflow for each country/region that you operate in, such

as Purchase Requisitions Denmark and Purchase Requisitions Spain, with the following conditions:

Purchase Requisitions Denmark is used when: country/region = DK

Purchase Requisitions Spain is used when: country/region = ES

Follow these steps to specify when the workflow that you're configuring is used.

1. In the left pane, click ActivationActivation.

2. Select the Set the conditions for running this workflowSet the conditions for running this workflow  check box.

3. Click Add conditionAdd condition.

4. Enter a condition.

5. Enter any additional conditions that are required.

6. Run through the workflow with some target records to verify that the condition correctly includes and

excludes records.

When a document is submitted for processing, a workflow instance is created. You can send notifications to

users when workflow instances that are based on the workflow are started, completed, terminated, or stopped

because of an error. Follow these steps to specify when notifications are sent.

1. In the left pane, click NotificationsNotifications .

2. Select the check box for each event that should trigger notifications:

Star tedStar ted – Send notifications when a workflow instance is started.

StoppedStopped – Send notifications when a workflow instance is stopped because of an error.

CompletedCompleted – Send notifications when a workflow instance is completed.
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Participant Users who are assigned to a specific
group or role

Workflow user Users who are participants in this
workflow

User Specific users

UnrecoverableUnrecoverable – Send notifications when a workflow instance is stopped because of an

unrecoverable error.

TerminatedTerminated – Send notifications when a workflow instance is terminated.

3. Select the row for an event that you selected in step 2.

4. On the Notification textNotification text tab, enter the text of the notification.

5. To personalize the text, you can insert placeholders. Placeholders are replaced with the appropriate data

when the text is shown to users. To insert a placeholder, follow these steps:

a. Click in the field to specify where the placeholder should appear.

b. Click Inser t placeholderInser t placeholder .

c. In the list that appears, select the placeholder to insert.

d. Click Inser tInser t.

e. A common Notification textNotification text placeholder to include is "Last Notes: %Workflow.Last note%", which

displays any comments from the previous step.

6. To add translations of the text, follow these steps:

a. Click TranslationsTranslations .

b. On the page that appears, Click AddAdd.

c. In the list that appears, select the language that you will enter the text in.

d. In the Translated textTranslated text field, enter the text.

e. To personalize the text, you can insert placeholders. For instructions about how to enter a placeholder,

see step 5.

f. Click CloseClose.

7. On the RecipientRecipient tab, use the following options to specify who should receive the notifications.

1. On the RecipientRecipient  tab, click
Par ticipantPar ticipant .

2. On the Role basedRole based tab, in
the Type of par ticipantType of par ticipant
list, select the type of group
or role to send notifications
to.

3. In the Par ticipantPar ticipant  list, select
the group or role to send
notifications to.

1. On the RecipientRecipient  tab, click
Workflow userWorkflow user .

2. On the Workflow userWorkflow user  tab,
in the Workflow userWorkflow user  list,
select a participant in this
workflow.

1. On the RecipientRecipient  tab, click
UserUser .

2. On the UserUser  tab, the
Available usersAvailable users  list
includes all users. Select the
users to send notifications
to, and move those users
into the Selected usersSelected users  list.



Enter comments about the changes that you made to the workflow

NOTENOTE

8. Repeat steps 3 through 7 for each event that you selected in step 2.

To enter comments about the changes that you made to the workflow, follow these steps.

1. In the left pane, click NotesNotes .

2. In the Enter comments about the workflowEnter comments about the workflow  field, enter your comments.

3. Review your comments. After you add comments, you can't modify them.

4. Click AddAdd to add your comments to the Comment histor yComment histor y  area.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Name the task

Enter a subject line and instructions

This topic explains how to configure the properties for a manual task.

To configure a manual task in the workflow editor, right-click the task, and then click Proper tiesProper ties  to open the

Proper tiesProper ties  page. Then use the following procedures to configure the properties for the manual task.

Follow these steps to enter a name for the manual task.

1. In the left pane, click Basic SettingsBasic Settings .

2. In the NameName field, enter a unique name for the task.

You must provide a subject line and instructions to users who are assigned to the task. For example, if you're

configuring a task for purchase requisitions, the user who is assigned to the task sees the subject line and

instructions on the Purchase requisitionsPurchase requisitions  page. The subject line appears in a message bar on the page. The

user can then click the icon in the message bar to view the instructions. Follow these steps to enter a subject line

and instructions.

1. In the left pane, click Basic SettingsBasic Settings .

2. In the Work item subjectWork item subject field, enter the subject line.

3. To personalize the subject line, you can insert placeholders. Placeholders are replaced with appropriate

data when the subject line is shown to users. Follow these steps to insert a placeholder :

a. In the text box, click where the placeholder should appear.

b. Click Inser t placeholderInser t placeholder .

c. In the list that appears, select the placeholder to insert.

d. Click Inser tInser t.

4. To add translations of the subject line, follow these steps:

a. Click TranslationsTranslations .

b. On the page that appears, click AddAdd.

c. In the list that appears, select the language that you're entering the text in.

d. In the Translated textTranslated text field, enter the text.

e. To personalize the text, you can insert placeholders as described in step 3.

f. Click CloseClose.

5. In the Work item instructionsWork item instructions  field, enter the instructions.

6. To personalize the instructions, you can insert placeholders. Placeholders are replaced with appropriate

data when the instructions are shown to users. Follow these steps to insert a placeholder :

a. In the text box, click where the placeholder should appear.

b. Click Inser t placeholderInser t placeholder .

c. In the list that appears, select the placeholder to insert.

d. Click Inser tInser t.
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Assign the task

7. To add translations of the instructions, follow these steps:

a. Click TranslationsTranslations .

b. On the page that appears, click AddAdd.

c. In the list that appears, select the language that you're entering the text in.

d. In the Translated textTranslated text field, enter the text.

e. To personalize the text, you can insert placeholders as described in step 6.

f. Click CloseClose.

Follow these steps to specify who the manual task should be assigned to.

O P T IO NO P T IO N
USERS T H AT  T H E TA SK  IS A SSIGN EDUSERS T H AT  T H E TA SK  IS A SSIGN ED
TOTO A DDIT IO N A L  ST EP SA DDIT IO N A L  ST EP S

Participant Users who are assigned to a specific
group or role

1. In the left pane, click AssignmentAssignment.

2. On the Assignment typeAssignment type tab, select one of the options in the following table, and then follow the

additional steps for that option before you go to step 3.

1. After you select Par ticipantPar ticipant ,
on the Role basedRole based tab, in
the Type of par ticipantType of par ticipant
list, select the type of group
or role to assign the task to.

2. In the Par ticipantPar ticipant  list, select
the group or role to assign
the task to.



Hierarchy Users in a specific organizational
hierarchy

Workflow user Users in the current workflow
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1. After you select HierarchyHierarchy ,
on the Hierarchy selectionHierarchy selection
tab, in the Hierarchy typeHierarchy type
list, select the type of
hierarchy to assign the task
to.

2. The system must retrieve a
range of user names from
the hierarchy. These names
represent users that the task
can be assigned to. Follow
these steps to specify the
starting point and ending
point of the range of user
names that the system
retrieves:

3. On the Hierarchy optionsHierarchy options
tab, specify which users in
the range the task should be
assigned to:

a. To specify the
starting point, select
a person in the Star tStar t
fromfrom list.

b. To specify the ending
point, click AddAdd
conditioncondition. Then
enter a condition that
determines where in
the hierarchy the
system stops
retrieving names.

Assign to all usersAssign to all users
retrievedretrieved – The task
is assigned to all
users in the range.

Assign only to lastAssign only to last
user retrieveduser retrieved –
The task is assigned
to only the last user
in the range.

Exclude users withExclude users with
the followingthe following
conditioncondition – The task
isn't assigned to
users in the range
who meet a specific
condition. Click AddAdd
conditioncondition to specify
the condition.

After you select WorkflowWorkflow
useruser , on the WorkflowWorkflow
useruser  tab, in the WorkflowWorkflow
useruser  list, select a user who
participates in the workflow.



Specify what happens when the task is overdue

User Specific users

Queue A work item queue

[!NOTE] This option is used for
only a few workflows, such as
Case management.
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1. After you select UserUser , click
the UserUser  tab.

2. The Available usersAvailable users  list
includes all users. Select the
users to assign the task to,
and then move those users
to the Selected usersSelected users  list.

1. After you select QueueQueue, click
the Queue basedQueue based tab.

2. To assign the task to a
specific queue, follow these
steps:

3. If a specific condition should
determine which queue the
task is assigned to, follow
these steps:

a. In the Queue typeQueue type
list, select WorkWork
item queuesitem queues .

b. In the Queue nameQueue name
list, select the queue.

a. In the Queue typeQueue type
list, select
Conditional workConditional work
item queuesitem queues .

b. In the Queue nameQueue name
list, select
Conditional queueConditional queue.

3. On the Time limitTime limit tab, in the DurationDuration field, specify how much time the user has to complete the task.

Select one of the following options:

HoursHours  – Enter the number of hours that the user has to complete the task. Then select the calendar

that your organization uses, and enter information about your organization's work week.

DaysDays  – Enter the number of days that the user has to complete the task. Then select the calendar that

your organization uses, and enter information about your organization's work week.

WeeksWeeks  – Enter the number of weeks that the user has to complete the task.

MonthsMonths  – Select the day and week that the user must complete the task by. For example, you might

want the user to complete the task by Friday of the third week of the month.

YearsYears  – Select the day, week, and month that the user must complete the task by. For example, you

might want the user to complete the task by Friday of the third week of December.

If the user doesn't complete the task in the allotted time, the task is overdue. A task that is overdue can be

escalated, based on the options that you select in the EscalationEscalation area of the page.

If a user doesn't complete the manual task in the allotted time, the task is overdue. A task that is overdue can be

escalated, or automatically assigned to another user. Follow these steps to escalate the task if it's overdue.



SEQ UEN C ESEQ UEN C E ESC A L AT IO N  PAT HESC A L AT IO N  PAT H

1 Assign to: Donna

2 Assign to: Erin

3 Final action: Reject
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1. In the left pane, click EscalationEscalation.

2. Select the Use escalation pathUse escalation path check box to create an escalation path. The system automatically assigns

the task to the users who are listed in the escalation path. For example, the following table represents an

escalation path.

In this example, the system assigns the overdue task to Donna. If Donna doesn't complete the task in the

allotted time, the system assigns the task to Erin. If Erin doesn't complete the task in the allotted time, the

system rejects the document that was submitted for processing.

3. To add a user to the escalation path, click Add escalationAdd escalation. On the Assignment typeAssignment type tab, select one of

the options in the following table, and then follow the additional steps for that option before you go to

step 4.



Hierarchy Users in a specific organizational
hierarchy

Workflow user Users in the current workflow
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1. After you select HierarchyHierarchy ,
on the Hierarchy selectionHierarchy selection
tab, in the Hierarchy typeHierarchy type
list, select the type of
hierarchy to escalate the task
to.

2. The system must retrieve a
range of user names from
the hierarchy. These names
represent users that the task
can be escalated to. Follow
these steps to specify the
starting point and ending
point of the range of user
names that the system
retrieves:

3. On the Hierarchy optionsHierarchy options
tab, specify which users in
the range the task should be
escalated to:

a. To specify the
starting point, select
a person in the Star tStar t
fromfrom list.

b. To specify the ending
point, click AddAdd
conditioncondition. Then
enter a condition that
determines where in
the hierarchy the
system stops
retrieving names.

Assign to all usersAssign to all users
retrievedretrieved – The task
is escalated to all
users in the range.

Assign only to lastAssign only to last
user retrieveduser retrieved –
The task is escalated
to only the last user
in the range.

Exclude users withExclude users with
the followingthe following
conditioncondition – This
task isn't escalated to
users in the range
who meet a specific
condition. Click AddAdd
conditioncondition to specify
the condition.

After you select WorkflowWorkflow
useruser , on the WorkflowWorkflow
useruser  tab, in the WorkflowWorkflow
useruser  list, select a user who
participates in the workflow.



Specify when the system automatically acts on the task

User Specific users
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1. After you select UserUser , click
the UserUser  tab.

2. The Available usersAvailable users  list
includes all users. Select the
users to escalate the task to,
and then move those users
to the Selected usersSelected users  list.

4. On the Time limitTime limit tab, in the DurationDuration field, specify how much time the user has to complete the task.

Select one of the following options:

HoursHours  – Enter the number of hours that the user has to complete the task. Then select the calendar

that your organization uses, and enter information about your organization's work week.

DaysDays  – Enter the number of days that the user has to complete the task. Then select the calendar that

your organization uses, and enter information about your organization's work week.

WeeksWeeks  – Enter the number of weeks that the user has to complete the task.

MonthsMonths  – Select the day and week that the user must complete the task by. For example, you might

want the user to complete the task by Friday of the third week of the month.

YearsYears  – Select the day, week, and month that the user must complete the task by. For example, you

might want the user to complete the task by Friday of the third week of December.

5. Repeat steps 3 through 4 for each user that should be added to the escalation path. You can change the

order of the users.

6. If the users in the escalation path don't complete the task in the allotted time, the system takes action on

the task. To specify the action that the system takes, select the ActionAction row, and then, on the End actionEnd action

tab, select an action.

You can configure the system to take action on the manual task if specific conditions are met. For example, a task

requires that a member of the Expense reports department review the receipts that are submitted together with

an expense report. According to company policy, this task must be performed if the total amount of the expense

report is more than USD 100. In this scenario, you can configure the system to automatically mark the task as

CompleteComplete when the total amount is less than 100. Follow these steps to specify when the system takes action

on the manual task.

1. In the left pane, click Automatic actionsAutomatic actions .

2. Select the Enable automatic actionsEnable automatic actions  check box.

3. Click Add conditionAdd condition.

4. Enter a condition.

5. Enter any additional conditions that are required.

6. To verify that the conditions that you entered are configured correctly, follow these steps:

a. Click TestTest.

b. On the Test workflow conditionTest workflow condition page, in the Validate conditionValidate condition area, select a record.

c. Click TestTest. The system evaluates the record to determine whether it meets the conditions that you

defined.

d. Click OKOK or CancelCancel  to return to the Proper tiesProper ties  page.



Specify when notifications are sent

7. In the Auto complete actionAuto complete action list, select the action that the system should take on the task.

You can send notifications to people when a manual task has been delegated, escalated, completed, or rejected,

or when a change has been requested. Follow these steps to specify when notifications are sent, and who the

notifications are sent to.
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Participant Users who are assigned to a specific
group or role

1. In the left pane, click NotificationsNotifications .

2. Select the check box next to the events that notifications should be sent for :

DelegateDelegate – The task has been assigned to another user.

EscalateEscalate – The assigned user hasn't completed the task in the allotted time.

CompleteComplete – The assigned user has completed the task.

RejectReject – The assigned user has rejected the document that was submitted.

Request changeRequest change – The assigned user has requested a change to the document that was submitted.

3. Select the row for an event that you selected in step 2.

4. On the Notification textNotification text tab, in the text box, enter the text of the notification.

5. To personalize the notification, you can insert placeholders. Placeholders are replaced with appropriate

information when the notification is shown to users. Follow these steps to insert a placeholder :

a. In the text box, click where the placeholder should appear.

b. Click Inser t placeholderInser t placeholder .

c. In the list that appears, select the placeholder to insert.

d. Click Inser tInser t.

6. To add translations of the notification, follow these steps:

a. Click TranslationsTranslations .

b. On the page that appears, click AddAdd.

c. In the list that appears, select the language that you're entering the text in.

d. In the Translated textTranslated text field, enter the text.

e. To personalize the text, you can insert placeholders as described in step 5.

f. Click CloseClose.

7. On the RecipientRecipient tab, specify who the notifications are sent to. Select one of the options in the following

table, and then follow the additional steps for that option before you go to step 8.

1. After you select Par ticipantPar ticipant ,
on the Role basedRole based tab, in
the Type of par ticipantType of par ticipant
list, select the type of group
or role to send notifications
to.

2. In the Par ticipantPar ticipant  list, select
the group or role to send
notifications to.



Set a time limit

NOTENOTE

Specify which actions are available to the user

NOTENOTE

Workflow user Users in the current workflow

User Specific users
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After you select WorkflowWorkflow
useruser , on the WorkflowWorkflow
useruser  tab, in the WorkflowWorkflow
useruser  list, select a user who
participates in the workflow.

1. After you select UserUser , click
the UserUser  tab.

2. The Available usersAvailable users  list
includes all users. Select the
users to send notifications
to, and then move those
users to the Selected usersSelected users
list.

8. Repeat steps 3 through 7 for each event that you selected in step 2.

Follow these steps if the manual task must be completed in a specific time.

The options that you select in this procedure override the options that you selected in the AssignmentAssignment  and EscalationEscalation

areas of the page.

1. In the left pane, click Advanced settingsAdvanced settings .

2. Select the Set a time limit for the workflow elementSet a time limit for the workflow element check box.

3. In the DurationDuration field, specify when the task must be completed. Select one of the following options:

HoursHours  – Enter the number of hours that the task must be completed in. Then select the calendar that

your organization uses, and enter information about your organization's work week.

DaysDays  – Enter the number of days that the task must be completed in. Then select the calendar that

your organization uses, and enter information about your organization's work week.

WeeksWeeks  – Enter the number of weeks that the task must be completed in.

MonthsMonths  – Select the day and week that the task must be completed by. For example, you might want

the task to be completed by Friday of the third week of the month.

YearsYears  – Select the day, week, and month that the task must be completed by. For example, you might

want the task to be completed by Friday of the third week of December.

4. If the time limit is exceeded, the system takes action on the task. In the ActionAction list, select the action that

the system should take.

When the manual task is assigned to a user, the user must take action on the task. Follow these steps to specify

which actions the user can take on the task.

The actions that are available vary, depending on the design of the task.



NOTENOTE

1. In the left pane, click Advanced settingsAdvanced settings .

2. Select the CompleteComplete check box if the user should be able to mark the task as CompleteComplete.

3. Select the RejectReject check box if the user should be able to reject the document that was submitted.

4. Select the Request changeRequest change check box if the user should be able to request changes to the document that

was submitted.

5. Select the DelegateDelegate check box if the user should be able to assign the task to another user.

6. Select the ReassignReassign check box if the user should be able to reassign the task to another user in the work

item queue.

7. Select the ReleaseRelease check box if the user should be able to reassign the task to the work item queue. Another

user can then complete the task.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Configure automated tasks in a workflow
2/18/2021 • 2 minutes to read • Edit Online

Name the task

Specify when notifications are sent

This topic explains how to configure the properties for an automated task.

To configure an automated task in the workflow editor, right-click the task, and then click Proper tiesProper ties  to open

the Proper tiesProper ties  page. Then use the following procedures to configure the properties for the automated task.

Follow these steps to enter a name for the automated task.

1. In the left pane, click Basic SettingsBasic Settings .

2. In the NameName field, enter a unique name for the task.

You can send notifications to people when an automated task has been run or canceled. Follow these steps to

specify when notifications are sent, and who they are sent to.
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1. In the left pane, click NotificationsNotifications .

2. Select the check box next to the events to send notifications for :

ExecutionExecution – Notifications are sent when the task has been run.

CanceledCanceled – Notifications are sent when the task has been canceled.

3. Select the row for an event that you selected in step 2.

4. On the Notification textNotification text tab, in the text box, enter the text of the notification.

5. To personalize the notification, you can insert placeholders. Placeholders are replaced with appropriate

data when the notification is shown to users. Follow these steps to insert a placeholder :

a. In the text box, click where the placeholder should appear.

b. Click Inser t placeholderInser t placeholder .

c. In the list that appears, select the placeholder to insert.

d. Click Inser tInser t.

6. To add translations of the notification, follow these steps:

a. Click TranslationsTranslations .

b. On the page that appears, click AddAdd.

c. In the list that appears, select the language that you're entering the text in.

d. In the Translated textTranslated text field, enter the text.

e. To personalize the text, you can insert placeholders as described in step 5.

f. Click CloseClose.

7. On the RecipientRecipient tab, specify who the notifications are sent to. Select one of the options in the following

table, and then follow the additional steps for that option before you go to step 8.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/configure-automated-task-workflow.md


NOTENOTE

Participant Users who are assigned to a specific
group or role

Workflow user Users who participate in the current
workflow

User Specific users
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1. After you select Par ticipantPar ticipant ,
on the Role basedRole based tab, in
the Type of par ticipantType of par ticipant
list, select the type of group
or role to send notifications
to.

2. In the Par ticipantPar ticipant  list, select
the group or role to send
notifications to.

After you select WorkflowWorkflow
useruser , on the WorkflowWorkflow
useruser  tab, in the WorkflowWorkflow
useruser  list, select a user who
participates in the workflow.

1. After you select UserUser , click
the UserUser  tab.

2. The Available usersAvailable users  list
includes all users. Select the
users to send notifications
to, and then move those
users to the Selected usersSelected users
list.

8. Repeat steps 3 through 7 for each event that you selected in step 2.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Configure approval processes in a workflow
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Name the approval process

Specify when the system automatically acts on the document

Specify when notifications are sent

Use the following procedure to configure the properties of the approval process.

To configure an approval process, in the workflow editor, right-click the approval element, and then click

Proper tiesProper ties  to open the Proper tiesProper ties  form.

Follow these steps to enter a name for the approval process.

1. In the left pane, click Basic SettingsBasic Settings .

2. In the NameName field, enter a unique name for the approval process.

You can configure the system to automatically act on the document if specific conditions are met. For example,

the system can approve expense reports that have total amounts that are less than USD 100. Follow these steps

to specify when the system acts on the document.

1. In the left pane, click Automatic actionsAutomatic actions .

2. Select the Enable automatic actionsEnable automatic actions  check box.

3. Click Add conditionAdd condition.

4. Enter a condition.

5. Enter additional conditions, if necessary.

6. To verify that the conditions that you entered are configured correctly, complete the following steps:

a. Click TestTest to open the Test workflow conditionTest workflow condition form.

b. Select a record in the Validate conditionValidate condition area of the form.

c. Click TestTest. The system evaluates the record to determine whether it meets the conditions that you

defined.

d. Click OKOK or CancelCancel  to return to the Proper tiesProper ties  form.

7. In the Auto complete actionAuto complete action list, select the action that the system should take on the document.

You can send notifications to people when a document has been approved, rejected, delegated, or escalated, or

when a change has been requested. Follow these steps to specify when notifications are sent, and who the

notifications are sent to.

1. In the left pane, click NotificationsNotifications .

2. Select the check box next to the events to send notifications for :

DelegateDelegate – When a document has been assigned to another user for approval.

EscalateEscalate – When the assigned user has not acted on a document in the allotted time.

ApproveApprove – When a document has been approved.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/configure-approval-process-workflow.md
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Par ticipantPar ticipant Users who are assigned to a specific
group or role

Workflow userWorkflow user Users who participate in the current
workflow

UserUser Specific users

RejectReject – When a document has been rejected.

Request changeRequest change – When the assigned user has requested a change to a document that was

submitted.

3. Select the row for an event that you selected in step 2.

4. Click the Notification textNotification text tab.

5. In the text box, enter the text for the notification.

6. To personalize the text, you can insert placeholders, which are replaced with the appropriate data when

they are displayed to users. To insert a placeholder, follow these steps:

a. Click in the text box at the location where the placeholder should appear.

b. Click Inser t placeholderInser t placeholder .

c. In the list that is displayed, select the placeholder to insert.

d. Click Inser tInser t.

7. To add translations of the notification, click TranslationsTranslations . In the form that is displayed, follow these steps:

a. Click AddAdd.

b. In the list that is displayed, select the language in which you will enter the text.

c. In the Translated textTranslated text text box, enter the text.

d. To personalize the text, insert placeholders.

e. Click CloseClose.

8. Click the RecipientRecipient tab.

9. Specify who the notifications are sent to. Select one of the options in the following table, and then follow

the additional steps for the option before you go to step 10.

1. After you select Par ticipantPar ticipant ,
click the Role basedRole based tab.

2. In the Type of par ticipantType of par ticipant
list, select the type of group
or role to send notifications
to.

3. In the Par ticipantPar ticipant  list, select
the group or role to send
notifications to.

1. After you select WorkflowWorkflow
useruser , click the WorkflowWorkflow
useruser  tab.

2. In the Workflow userWorkflow user  list,
select a user who
participates in the workflow.

1. After you select UserUser , click
the UserUser  tab.

2. Select the users to send
notifications to, and then
move these users to the
Selected usersSelected users  list.

10. Repeat steps 3 through 9 for each event that you selected in step 2.



Specify a final approver

Set a time limit

NOTENOTE

Specify which actions are available to the user

You can designate a final approver for scenarios where the approver is the person who submitted the document

for approval and the "disallow approval by submitter" is being used. Follow these steps to specify a final

approver.

1. In the workflow editor, right-click the approval element, and then select Proper tiesProper ties  to open the Proper tiesProper ties

form.

2. In the left pane, click Advanced settingsAdvanced settings .

3. Select the Use final approverUse final approver  check box.

4. In the list, select a user to be the final approver.

Follow these steps if the approval process must be completed in a specific time.

The options that you select in these steps override the options that you selected in the AssignmentAssignment  and EscalationEscalation

areas of each approval step.

1. In the left pane, click Advanced settingsAdvanced settings .

2. Select the Set a time limit for the workflowSet a time limit for the workflow  elementelement check box.

3. In the DurationDuration field, specify when the approval process must be completed. Select one of the following

options:

HoursHours  – Enter the number of hours in which the approval process must be completed. Then select the

calendar that your organization uses, and enter information about your organization's work week.

DaysDays  – Enter the number of days in which the approval process must be completed. Then select the

calendar that your organization uses, and enter information about your organization's work week.

WeeksWeeks  – Enter the number of weeks in which the approval process must be completed.

MonthsMonths  – Select the day and week by which the approval process must be completed. For example,

you may want the approval process to be completed by Friday of the third week of the month.

YearsYears  – Select the day, week, and month by which the approval process must be completed. For

example, you may want the approval process to be completed by Friday of the third week of

December.

4. If the time limit is exceeded, the system acts on the document. In the ActionAction list, select the action that the

system should take.

When a document is assigned to a user for approval, the user must act on the document. Follows these steps to

specify which actions the user can take on the document that was submitted.

1. In the left pane, click Advanced settingsAdvanced settings .

2. Select the ApproveApprove check box if the user can approve the document.

3. Select the RejectReject check box the user can reject the document.

4. Select the Request changeRequest change check box the user can request changes to the document.

5. Select the DelegateDelegate check box if the user can assign the document to another user for approval.
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Configure the approval steps

NOTENOTE

The Enable actions from the work list in Enterprise Por talEnable actions from the work list in Enterprise Por tal check box has been deprecated.

An approval process consists of approval steps. Complete the following procedure to add steps the approval

process and configure the steps.

1. In the workflow editor, double-click the approval process. The workflow editor displays the steps of the

approval process.

2. To add an approval step, drag the step from the Workflow elementsWorkflow elements  area to the canvas.

3. To configure an approval step, see Configure approval steps in a workflow.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Name the step

Enter a subject line and instructions

This topic explains how to configure the properties of an approval step.

To configure an approval step in the workflow editor, right-click the approval step, and then click Proper tiesProper ties  to

open the Proper tiesProper ties  page. Then use the following procedures to configure the properties of the approval step.

Follow these steps to enter a name for the approval step.

1. In the left pane, click Basic SettingsBasic Settings .

2. In the NameName field, enter a unique name for the approval step.

You must provide a subject line and instructions to users who are assigned to the approval step. For example, if

you're configuring an approval step for purchase requisitions, the user who is assigned to the step sees the

subject line and instructions on the Purchase requisitionsPurchase requisitions  page. The subject line appears in a message bar on

the page. The user can then click the icon in the message bar to see the instructions. Follow these steps to enter

a subject line and instructions.

1. In the left pane, click Basic SettingsBasic Settings .

2. In the Work item subjectWork item subject field, enter the subject line.

3. To personalize the subject line, you can insert placeholders. Placeholders are replaced with appropriate

data when the subject line is shown to users. Follow these steps to insert a placeholder :

a. In the text box, click where the placeholder should appear.

b. Click Inser t placeholderInser t placeholder .

c. In the list that appears, select the placeholder to insert.

d. Click Inser tInser t.

4. To add translations of the subject line, follow these steps:

a. Click TranslationsTranslations .

b. On the page that appears, click AddAdd.

c. In the list that appears, select the language that you're entering the text in.

d. In the Translated textTranslated text field, enter the text.

e. To personalize the text, you can insert placeholders as described in step 3.

f. Click CloseClose.

5. In the Work item instructionsWork item instructions  field, enter the instructions.

6. To personalize the instructions, you can insert placeholders. Placeholders are replaced with appropriate

data when the instructions are shown to users. Follow these steps to insert a placeholder :

a. In the text box, click where the placeholder should appear.

b. Click Inser t placeholderInser t placeholder .

c. In the list that appears, select the placeholder to insert.

d. Click Inser tInser t.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/configure-approval-step-workflow.md


Assign the approval step

7. To add translations of the instructions, follow these steps:

a. Click TranslationsTranslations .

b. On the page that appears, click AddAdd.

c. In the list that appears, select the language that you're entering the text in.

d. In the Translated textTranslated text field, enter the text.

e. To personalize the text, you can insert placeholders as described in step 6.

f. Click CloseClose.

Follow these steps to specify who the approval step should be assigned to.
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Participant Users who are assigned to a specific
group or role

1. In the left pane, click AssignmentAssignment.

2. On the Assignment typeAssignment type tab, select one of the options in the following table, and then follow the

additional steps for that option before you go to step 3.

1. After you select Par ticipantPar ticipant ,
on the Role basedRole based tab, in
the Type of par ticipantType of par ticipant
list, select the type of group
or role to assign the step to.

2. In the Par ticipantPar ticipant  list, select
the group or role to assign
the step to.



Hierarchy Users in a specific organizational
hierarchy

Workflow user Users in the current workflow
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1. After you select HierarchyHierarchy ,
on the Hierarchy selectionHierarchy selection
tab, in the Hierarchy typeHierarchy type
list, select the type of
hierarchy to assign the step
to.

2. The system must retrieve a
range of user names from
the hierarchy. These names
represent users that the step
can be assigned to. Follow
these steps to specify the
starting point and ending
point of the range of user
names that the system
retrieves:

3. On the Hierarchy optionsHierarchy options
tab, specify which users in
the range the step should be
assigned to:

a. To specify the
starting point, select
a person in the Star tStar t
fromfrom list.

b. To specify the ending
point, click AddAdd
conditioncondition. Then
enter a condition that
determines where in
the hierarchy the
system stops
retrieving names.

Assign to all usersAssign to all users
retrievedretrieved – The step
is assigned to all
users in the range.

Assign only to lastAssign only to last
user retrieveduser retrieved –
The step is assigned
to only the last user
in the range.

Exclude users withExclude users with
the followingthe following
conditioncondition – The step
isn't assigned to any
users in the range
who meet a specific
condition. Click AddAdd
conditioncondition to specify
the condition.

After you select WorkflowWorkflow
useruser , on the WorkflowWorkflow
useruser  tab, in the WorkflowWorkflow
useruser  list, select a user who
participates in the workflow.



User Specific users
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1. After you select UserUser , click
the UserUser  tab.

2. The Available usersAvailable users  list
includes all system users.
Select the users to assign the
step to, and then move
those users to the SelectedSelected
usersusers  list.

3. On the Time limitTime limit tab, in the DurationDuration field, specify how much time the user has to take action on, or

respond to, documents that reach the approval step. Select one of the following options:

HoursHours  – Enter the number of hours that the user has to respond. Then select the calendar that your

organization uses, and enter information about your organization's work week.

DaysDays  – Enter the number of days that the user has to respond. Then select the calendar that your

organization uses, and enter information about your organization's work week.

WeeksWeeks  – Enter the number of weeks that the user has to respond.

MonthsMonths  – Select the day and week that the user must respond by. For example, you might want the

user to respond by Friday of the third week of the month.

YearsYears  – Select the day, week, and month that the user must respond by. For example, you might want

the user to respond by Friday of the third week of December.

If the user doesn't take action on the document in the allotted time, the document is overdue. A document

that is overdue is escalated, based on the options that you select in the EscalationEscalation area of the page.

4. If you assigned the approval step to multiple users or a group of users, on the Completion policyCompletion policy  tab,

select one of the following options:

S ingle approverSingle approver  – The action that is applied to the document is determined by the first person

who responds. For example, Sam has submitted an expense report for USD 15,000. The expense

report is currently assigned to Sue, Jo, and Bill. If Sue is the first person who responds to the

document, the action that she takes is applied to the document. If Sue rejects the document, it's

rejected and sent back to Sam. If Sue approves the document, it's sent to Ann for approval.



Specify when the approval step is required

Majority of approversMajority of approvers  – The action that is applied to the document is determined when most of

the approvers respond. For example, Sam has submitted an expense report for USD 15,000. The

expense report is currently assigned to Sue, Jo, and Bill. If Sue and Jo are the first two approvers

who respond, the action that they take is applied to the document.

If Sue approves the document, but Jo rejects it, the document is rejected and sent back to Sam.

If both Sue and Jo approve the document, it's sent to Ann for approval.

Percentage of approversPercentage of approvers  – The action that is applied to the document is determined when a

specific percentage of the approvers respond. For example, Sam has submitted an expense report

for USD 15,000. The expense report is currently assigned to Sue, Jo, and Bill, and you entered 5050

as the percentage. If Sue and Jo are the first two approvers who respond, the action that they take

is applied to the document, because they meet the requirement for 50 percent of approvers.

If Sue approves the document, but Jo rejects it, the document is rejected and sent back to Sam.

If both Sue and Jo approve the document, it's sent to Ann for approval.

All approversAll approvers  – All the approvers must approve the document. Otherwise, the workflow can't

continue. For example, Sam has submitted an expense report for USD 15,000. The expense report

is currently assigned to Sue, Jo, and Bill. If Sue and Joe approve the document, but Bill rejects it, the

document is rejected and sent back to Sam. If Sue, Jo, and Bill all approve the document, it's sent to

Ann for approval.



The approval step is always requiredThe approval step is always required

The approval step is required in specific conditionsThe approval step is required in specific conditions

Specify what happens when the document is overdue

You can specify when the approval step is required. The approval step can always be required, or it can be

required only if specific conditions are met.

Follow these steps if the approval step is always required.

1. In the left pane, click ConditionCondition.

2. Select the Always run this stepAlways run this step option.

The approval step that you're configuring might be required only if specific conditions are met. For example, if

you're configuring an approval step for a purchase requisition workflow, you might want the approval step to

occur only if the amount of the purchase requisition is more than USD 10,000. Follow these steps to specify

when the approval step is required.

1. In the left pane, click ConditionCondition.

2. Select the Run this step only when the following condition is metRun this step only when the following condition is met option.

3. Enter a condition.

4. Enter any additional conditions that are required.

5. To verify that the conditions that you entered are configured correctly, follow these steps:

a. Click TestTest.

b. On the Test workflow conditionTest workflow condition page, in the Validate conditionValidate condition area, select a record.

c. Click TestTest. The system evaluates the record to determine whether it meets the conditions that you

defined.

d. Click OKOK or CancelCancel  to return to the Proper tiesProper ties  page.

If a user doesn't take action on a document in the allotted time, the document is overdue. A document that is

overdue can be escalated, or automatically assigned to another user for approval. Follow these steps to escalate

the document if it's overdue.

SEQ UEN C ESEQ UEN C E ESC A L AT IO N  PAT HESC A L AT IO N  PAT H

1 Assign to: Donna

2 Assign to: Erin

3 Final action: Reject

1. In the left pane, click EscalationEscalation.

2. Select the Use escalation pathUse escalation path check box to create an escalation path. The system automatically assigns

the document to the users who are listed in the escalation path. For example, the following table

represents an escalation path.

In this example, the system assigns the overdue document to Donna. If Donna doesn't respond in the

allotted time, the system assigns the document to Erin. If Erin doesn't respond in the allotted time, the

system rejects the document.

3. To add a user to the escalation path, click Add escalationAdd escalation. On the Assignment typeAssignment type tab, select one of

the options in the following table, and then follow the additional steps for that option before you go to
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Hierarchy Users in a specific organizational
hierarchy

step 4.

1. After you select HierarchyHierarchy ,
on the Hierarchy selectionHierarchy selection
tab, in the Hierarchy typeHierarchy type
list, select the type of
hierarchy to escalate the
document to.

2. The system must retrieve a
range of user names from
the hierarchy. These names
represent users that the
document can be escalated
to. Follow these steps to
specify the starting point
and ending point of the
range of user names that the
system retrieves:

3. On the Hierarchy optionsHierarchy options
tab, specify which users in
the range the document
should be escalated to:

a. To specify the
starting point, select
a person in the Star tStar t
fromfrom list.

b. To specify the ending
point, click AddAdd
conditioncondition. Then
enter a condition that
determines where in
the hierarchy the
system stops
retrieving names.

Assign to all usersAssign to all users
retrievedretrieved – The
document is
escalated to all users
in the range.

Assign only to lastAssign only to last
user retrieveduser retrieved –
The document is
escalated to only the
last user in the range.

Exclude users withExclude users with
the followingthe following
conditioncondition – The
document isn't
escalated to any
users in the range
who meet a specific
condition. Click AddAdd
conditioncondition to specify
the condition.
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After you select WorkflowWorkflow
useruser , on the WorkflowWorkflow
useruser  tab, in the WorkflowWorkflow
useruser  list, select a user who
participates in the workflow.

1. After you select UserUser , click
the UserUser  tab.

2. The Available usersAvailable users  list
includes all users. Select the
users to escalate the
document to, and then
move those users to the
Selected usersSelected users  list.

4. On the Time limitTime limit tab, in the DurationDuration field, specify how much time the user has to take action on, or

respond to, documents. Select one of the following options:

HoursHours  – Enter the number of hours that the user has to respond. Then select the calendar that your

organization uses, and enter information about your organization's work week.

DaysDays  – Enter the number of days that the user has to respond. Then select the calendar that your

organization uses, and enter information about your organization's work week.

WeeksWeeks  – Enter the number of weeks that the user has to respond.

MonthsMonths  – Select the day and week that the user must respond by. For example, you might want the

user to respond by Friday of the third week of the month.

YearsYears  – Select the day, week, and month that the user must respond by. For example, you might want

the user to respond by Friday of the third week of December.

5. Repeat steps 3 through 4 for each user that should be added to the escalation path. You can change the

order of the users.

6. If the users in the escalation path don't respond in the allotted time, the system automatically take action

on the document. To specify the action that the system takes, select the ActionAction row, and then, on the EndEnd

actionaction tab, select an action.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Name the decision

Enter a subject line and instructions

This topic explains how to configure the properties of a manual decision.

To configure a manual decision in the workflow editor, right-click the manual decision, and then click Proper tiesProper ties

to open the Proper tiesProper ties  page. Then use the following procedures to configure the properties of the manual

decision.

Follow these steps to enter a name for the manual decision.

1. In the left pane, click Basic SettingsBasic Settings .

2. In the NameName field, enter a unique name for the manual decision.

You must provide a subject line and instructions to users who are assigned to the manual decision. For example,

if you're configuring a decision for purchase requisitions, the user who is assigned to the decision sees the

subject line and instructions on the Purchase requisitionsPurchase requisitions  page. The subject line appears in a message bar on

the page. The user can then click the icon in the message bar to view the instructions. Follow these steps to enter

a subject line and instructions.

1. In the left pane, click Basic SettingsBasic Settings .

2. On the InstructionsInstructions  tab, in the Work item subjectWork item subject field, enter the subject line.

3. To personalize the subject line, you can insert placeholders. Placeholders are replaced with appropriate

data when the subject line is shown to users. Follow these steps to insert a placeholder :

a. In the text box, click where the placeholder should appear.

b. Click Inser t placeholderInser t placeholder .

c. In the list that appears, select the placeholder to insert.

d. Click Inser tInser t.

4. To add translations of the subject line, follow these steps:

a. Click TranslationsTranslations .

b. On the page that appears, click AddAdd.

c. In the list that appears, select the language that you're entering the text in.

d. In the Translated textTranslated text field, enter the text.

e. To personalize the text, you can insert placeholders as described in step 3.

f. Click CloseClose.

5. In the Work item instructionsWork item instructions  field, enter the instructions.

6. To personalize the instructions, you can insert placeholders. Placeholders are replaced with appropriate

data when the instructions are shown to users. Follow these steps to insert a placeholder :

a. In the text box, click where the placeholder should appear.

b. Click Inser t placeholderInser t placeholder .

c. In the list that appears, select the placeholder to insert.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/configure-manual-decision-workflow.md


Specify the possible outcomes of a decision

Specify when notifications are sent

d. Click Inser tInser t.

7. To add translations of the instructions, follow these steps:

a. Click TranslationsTranslations .

b. On the page that appears, click AddAdd.

c. In the list that appears, select the language that you're entering the text in.

d. In the Translated textTranslated text field, enter the text.

e. To personalize the text, you can insert placeholders as described in step 6.

f. Click CloseClose.

Typically, when a document is assigned to a decision maker, the decision maker is asked a question. The answer

to this question is usually YesYes  or NoNo, or TrueTrue or FalseFalse. Follow these steps to specify the possible outcomes of

the manual decision.

1. In the left pane, click Basic SettingsBasic Settings .

2. On the OutcomesOutcomes  tab, in the Outcome 1Outcome 1  field, enter the name of the outcome, or the option.

3. To add translations of the outcome, follow these steps:

a. Click TranslationsTranslations .

b. On the page that appears, click AddAdd.

c. In the list that appears, select the language that you're entering the text in.

d. In the Translated textTranslated text field, enter the text.

e. Click CloseClose.

4. In the Outcome 2Outcome 2  field, enter the name of the outcome, or the option.

5. To add translations of the outcome, follow these steps:

a. Click TranslationsTranslations .

b. On the page that appears, click AddAdd.

c. In the list that appears, select the language that you're entering the text in.

d. In the Translated textTranslated text field, enter the text.

e. Click CloseClose.

You can send notifications to people when a decision has been made, delegated, or escalated. Follow these steps

to specify when notifications are sent, and who the notifications are sent to.

1. In the left pane, click NotificationsNotifications .

2. Select the check box next to the events that notifications should be sent for :

[Choice 1][Choice 1]  – The assigned user has selected [Choice 1][Choice 1] .

[Choice 2][Choice 2]  – The assigned user has selected [Choice 2][Choice 2] .

DelegateDelegate – The assigned user has assigned the decision to another user.

EscalateEscalate – The assigned user hasn't made the decision in the allotted time.

3. Select the row for an event that you selected in step 2.

4. On the Notification textNotification text tab, in the text box, enter the text of the notification.

5. To personalize the notification, you can insert placeholders. Placeholders are replaced with appropriate
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Participant Users who are assigned to a specific
group or role

Workflow user Users in the current workflow

User Specific users

data when the notification is show to users. Follow these steps to insert a placeholder :

a. In the text box, click where the placeholder should appear.

b. Click Inser t placeholderInser t placeholder .

c. In the list that appears, select the placeholder to insert.

d. Click Inser tInser t.

6. To add translations of the notification, follow these steps:

a. Click TranslationsTranslations .

b. On the page that appears, click AddAdd.

c. In the list that appears, select the language that you're entering the text in.

d. In the Translated textTranslated text field, enter the text.

e. To personalize the text, you can insert placeholders as described in step 5.

f. Click CloseClose.

7. On the RecipientRecipient tab, specify who the notifications are sent to. Select one of the options in the following

table, and then follow the additional steps for that option before you go to step 8.

1. After you select Par ticipantPar ticipant ,
on the Role basedRole based tab, in
the Type of par ticipantType of par ticipant
list, select the type of group
or role to send notifications
to.

2. In the Par ticipantPar ticipant  list, select
the group or to send
notifications to.

After you select WorkflowWorkflow
useruser , on the WorkflowWorkflow
useruser  tab, in the WorkflowWorkflow
useruser  list, select a user who
participates in the workflow.

1. After you select UserUser , click
the UserUser  tab.

2. The Available usersAvailable users  list
includes all users. Select the
users to send notifications
to, and then move those
users to the Selected usersSelected users
list.

8. Repeat steps 3 through 7 for each event that you selected in step 2.

Follow these steps to specify who a manual decision should be assigned to.

1. In the left pane, click AssignmentAssignment.

2. On the Assignment typeAssignment type tab, select one of the options in the following table, and then follow the

additional steps for that option before you go to step 3.
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Participant Users who are assigned to a specific
group or role

1. After you select Par ticipantPar ticipant ,
on the Role basedRole based tab, in
the Type of par ticipantType of par ticipant
list, select the type of group
or role to assign the decision
to.

2. In the Par ticipantPar ticipant  list, select
the group or role to assign
the decision to.
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1. After you select HierarchyHierarchy ,
on the Hierarchy selectionHierarchy selection
tab, in the Hierarchy typeHierarchy type
list, select the type of
hierarchy to assign the
decision to.

2. The system must retrieve a
range of user names from
the hierarchy. These names
represent users that the
decision can be assigned to.
Follow these steps to specify
the starting point and
ending point of the range of
user names that the system
retrieves:

3. On the Hierarchy optionsHierarchy options
tab, specify which users in
the range the decision
should be assigned to:

a. To specify the
starting point, select
a person in the Star tStar t
fromfrom list.

b. To specify the ending
point, click AddAdd
conditioncondition. Then
enter a condition that
determines where in
the hierarchy the
system stops
retrieving names.

Assign to all usersAssign to all users
retrievedretrieved – The
decision is assigned
to all users in the
range.

Assign only to lastAssign only to last
user retrieveduser retrieved –
The decision is
assigned to only the
last user in the range.

Exclude users withExclude users with
the followingthe following
conditioncondition – The
decision isn't
assigned to any users
in the range who
meet a specific
condition. Click AddAdd
conditioncondition to specify
the condition.

After you select WorkflowWorkflow
useruser , on the WorkflowWorkflow
useruser  tab, in the WorkflowWorkflow
useruser  list, select a user who
participates in the workflow.
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1. After you select UserUser , click
the UserUser  tab.

2. The Available usersAvailable users  list
includes all users. Select the
users to assign the decision
to, and then move those
users to the Selected usersSelected users
list.

3. On the Time limitTime limit tab, in the DurationDuration field, specify how much time the user has to make the decision.

Select one of the following options:

HoursHours  – Enter the number of hours that the user has to make the decision. Then select the calendar

that your organization uses, and enter information about your organization's work week.

DaysDays  – Enter the number of days that the user has to make the decision. Then select the calendar that

your organization uses, and enter information about your organization's work week.

WeeksWeeks  – Enter the number of weeks that the user has to make the decision.

MonthsMonths  – Select the day and week that the user must make the decision by. For example, you might

want the user to make the decision by Friday of the third week of the month.

YearsYears  – Select the day, week, and month that the user must make the decision by. For example, you

might want the user to make the decision by Friday of the third week of December.

If the user doesn't make the decision in the allotted time, the decision is overdue. A decision that is

overdue is escalated, based on the options that you select in the EscalationEscalation area of the page.

If a user doesn't make the decision in the allotted time, the decision is overdue. A decision that is overdue can be

escalated, or automatically assigned to another user. Follow these steps to escalate the decision if it's overdue.

SEQ UEN C ESEQ UEN C E ESC A L AT IO N  PAT HESC A L AT IO N  PAT H

1 Assign to: Donna

2 Assign to: Erin

3 Final action: [Choice 1]

1. In the left pane, click EscalationEscalation.

2. Select the Use escalation pathUse escalation path check box to create an escalation path. The system automatically assigns

the decision to the users who are listed in the escalation path. For example, the following table represents

an escalation path.

In this example, the system assigns the overdue decision to Donna. If Donna doesn't make the decision in

the allotted time, the system assigns the decision to Erin. If Erin doesn't make the decision in the allotted

time, the system selects [Choice 1][Choice 1]  as the decision.

3. To add a user to the escalation path, click Add escalationAdd escalation. Select one of the options in the following

table, and then follow the additional steps for that option before you go to step 4.
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1. After you select HierarchyHierarchy ,
on the Hierarchy selectionHierarchy selection
tab, in the Hierarchy typeHierarchy type
list, select the type of
hierarchy to escalate the
decision to.

2. The system must retrieve a
range of user names from
the hierarchy. These names
represent users that the
decision can be escalated to.
Follow these steps to specify
the starting point and
ending point of the range of
user names that the system
retrieves:

3. On the Hierarchy optionsHierarchy options
tab, specify which users in
the range the decision
should be escalated to:

a. To specify the
starting point, select
a person in the Star tStar t
fromfrom list.

b. To specify the ending
point, click AddAdd
conditioncondition. Then
enter a condition that
determines where in
the hierarchy the
system stops
retrieving names.

Assign to all usersAssign to all users
retrievedretrieved – The
decision is escalated
to all users in the
range.

Assign only to lastAssign only to last
user retrieveduser retrieved –
The decision is
escalated to only the
last user in the range.

Exclude users withExclude users with
the followingthe following
condition:condition:  – The
decision isn't
escalated to any
users in the range
who meet a specific
condition. Click AddAdd
conditioncondition to specify
the condition.

After you select WorkflowWorkflow
useruser , on the WorkflowWorkflow
useruser  tab, in the WorkflowWorkflow
useruser  list, select a user who
participates in the workflow.



Set a time limit
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1. After you select UserUser , click
the UserUser  tab.

2. The Available usersAvailable users  list
includes all users. Select the
users to escalate the decision
to, and then move those
users to the Selected usersSelected users
list.

4. On the Time limitTime limit tab, in the DurationDuration field, specify how much time the user has to make the decision.

Select one of the following options:

HoursHours  – Enter the number of hours that the user has to make the decision. Then select the calendar

that your organization uses, and enter information about your organization's work week.

DaysDays  – Enter the number of days that the user has to make the decision. Then select the calendar that

your organization uses, and enter information about your organization's work week.

WeeksWeeks  – Enter the number of weeks that the user has to make the decision.

MonthsMonths  – Select the day and week that the user must make the decision by. For example, you might

want the user to make the decision by Friday of the third week of the month.

YearsYears  – Select the day, week, and month that the user must make the decision by. For example, you

might want the user to make the decision by Friday of the third week of December.

5. Repeat steps 3 through 4 for each user that should be added to the escalation path. You can change the

order of the users.

6. If the users in the escalation path don't make the decision in the allotted time, the system makes the

decision. To specify the option that the system selects, select the ActionAction row, and then, on the End actionEnd action

tab, select an option.

Follow these steps if the decision must be made in a specific time.

The options that you select in this procedure override the options that you selected in the AssignmentAssignment  and EscalationEscalation

areas of the page.

1. In the left pane, click Advanced settingsAdvanced settings .

2. Select the Set a time limit for the workflow elementSet a time limit for the workflow element check box.

3. In the DurationDuration field, specify when the decision must be made. Select one of the following options:

HoursHours  – Enter the number of hours. Then select the calendar that your organization uses, and enter

information about your organization's work week.

DaysDays  – Enter the number of days. Then select the calendar that your organization uses, and enter

information about your organization's work week.

WeeksWeeks  – Enter the number of weeks.

MonthsMonths  – Select the day and week that the decision must be made by. For example, you might want

the decision to be made by Friday of the third week of the month.

YearsYears  – Select the day, week, and month that the decision must be made by. For example, you might
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want the decision to be made by Friday of the third week of December.

4. If the time limit is exceeded, the system makes the decision. In the ActionAction list, select the option that the

system should select.

Can you tell us about your documentation language preferences? Take a short survey.
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Name a decision

Set conditions
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Use the following procedure to configure the properties of a conditional decision.

A conditional decision is a point at which a workflow divides into two branches. To configure a conditional

decision, in the workflow editor, right-click the conditional decision, and then click Proper tiesProper ties  to open the

Proper tiesProper ties  form.

Follow these steps to enter a name for a conditional decision.

1. In the left pane, click Basic SettingsBasic Settings .

2. In the NameName field, enter a unique name for the conditional decision.

The system determines which branch is used by evaluating the submitted document to determine whether it

meets specific conditions.

1. In the left pane, click Basic SettingsBasic Settings .

2. Click Add conditionAdd condition.

3. Enter a condition.

4. Enter additional conditions, if they are required.

5. To verify that the conditions that you entered are configured correctly, complete the following steps:

a. Click TestTest to open the Test workflow conditionTest workflow condition form.

b. Select a record in the Validate conditionValidate condition area of the form.

c. Click TestTest. The system evaluates the record to determine whether it meets the conditions that you

defined.

d. Click OKOK or CancelCancel  to return to the Proper tiesProper ties  form.

Can you tell us about your documentation language preferences? Take a short survey.
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Name a parallel activity

Configure the branches of a parallel activity
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To configure a parallel activity, complete the following procedures in the workflow editor.

A parallel activity consists of workflow branches that run at the same time.

Follow these steps to enter a name for a parallel activity.

1. Right-click the parallel activity, and then click Proper tiesProper ties  to open the Proper tiesProper ties  form.

2. In the left pane, click Basic SettingsBasic Settings .

3. In the NameName field, enter a unique name for the parallel activity.

4. Click CloseClose.

Follow these steps to add and configure the branches of this parallel activity.

NOTENOTE

1. Double-click the parallel activity to display the branches of the parallel activity.

2. To add a branch, drag the BranchBranch element from the Workflow elementsWorkflow elements  area to an insertion point on

the canvas. The following figure shows an insertion point.

The order of the branches is not important because all the branches of a parallel activity run at the same time.

3. To configure each branch, see Configure parallel branches in a workflow.
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Name a branch

Design and configure the elements of a branch

Additional resources

NOTENOTE

To configure a parallel branch, complete the following procedures in the workflow editor.

A parallel branch is essentially a workflow that runs in the context of a parent workflow.

Follow these steps to enter a name for a parallel branch.

1. Right-click the parallel branch, and then click Proper tiesProper ties . The Proper tiesProper ties  form is displayed.

2. In the left pane, click Basic SettingsBasic Settings .

3. In the NameName field, enter a unique name for the parallel branch.

4. Click CloseClose.

Follow these steps to design and configure the elements of a parallel branch.

1. Double-click the parallel branch.

2. Drag workflow elements onto the canvas, and then configure the elements, just as you would to create any

other workflow. For more information, see Create workflows overview.

Create workflows overview
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Name the line-item workflow element

Specify whether the same workflow is used to process all line items
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This topic explains how to configure a line-item workflow element.

To configure a line-item workflow element, in the workflow editor, right-click the element, and then click

Proper tiesProper ties  to open the Proper tiesProper ties  page. Then use the following procedures to configure the properties of the

line-item workflow element.

Follow these steps to enter a name for the line-item workflow element.

1. In the left pane, click Basic SettingsBasic Settings .

2. In the NameName field, enter a unique name for the line-item workflow element.

Follow these steps to specify whether the same workflow is used to process all the line items on a document.

1. In the left pane, click Basic SettingsBasic Settings .

2. If the same workflow should process all the line items on a document, click Invoke a single workflowInvoke a single workflow

for all l ine-itemsfor all l ine-items . Then select the workflow to use to process the line items.

3. If a specific workflow should process line items that meet a specific set of conditions, click Invoke aInvoke a

workflow for each line-itemworkflow for each line-item. Then follow these steps to define the set of conditions:

a. Click AddAdd.

b. Select the condition in the table.

c. On the Condition nameCondition name tab, enter a name for the set of conditions that you're defining.

d. Click Add conditionAdd condition to enter a condition.

e. Enter any additional conditions that are required.

f. To verify that the set of conditions that you entered is configured correctly, click TestTest. On the TestTest

workflow conditionworkflow condition page, in the Validate conditionValidate condition area, select a record, and then click TestTest. The

system evaluates the record to determine whether it meets the conditions that you defined. Click OKOK

or CancelCancel  to return to the Proper tiesProper ties  page.

On the WorkflowWorkflow  tab, select the workflow select the workflow to use to process line items that meet the

set of conditions that you defined.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/configure-line-item-workflow.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Configure the Workflow message processing batch
job as critical
2/18/2021 • 2 minutes to read • Edit Online

NOTENOTE

The workflow system uses various batch jobs. Workflow message processingWorkflow message processing is an important batch job used

to process workflow messages. If workflow is a key component of your organization, you should consider

configuring the Workflow message processingWorkflow message processing batch job as critical.

Configuring the Workflow message processingWorkflow message processing batch job as critical ensures that the system actively tracks

its status. When a critical batch job fails, the support team can better monitor failures and take action to resolve

any issues that may have caused the failure.

Follow these steps to configure the Workflow message processingWorkflow message processing batch job as critical.

1. Navigate to the Batch jobsBatch jobs  page.

2. Search for Workflow message processingWorkflow message processing using the quick filter.

3. Select the Workflow message processingWorkflow message processing batch job.

4. Click EditEdit in the action pane.

5. Select the Critical JobCritical Job check box.

6. Click SaveSave in the action pane.
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Manually delegate a work item

Manually delegate multiple work items

Automatically delegate work items

Set up automatic delegationSet up automatic delegation

To delegate an individual work item, select the DelegateDelegate option in the WorkflowWorkflow  menu and then enter the user

to be delegated to along with a comment. This will reassign the work item to that user so they can complete it.

Multiple work items can be delegated together from the Work items assigned to meWork items assigned to me page. The following

workflow types are eligible for mass delegation: Purchase agreement approval workflow, Purchase order

workflow, Purchase requisition review, and Vendor invoice workflow. The Delegate multiple work itemsDelegate multiple work items

feature is disabled by default and can be enabled in Workspaces > Feature managementWorkspaces > Feature management. Contact your

system administrator for help with enabling this feature.

1. Go to Common > Common > Work items > Work items assigned to meCommon > Common > Work items > Work items assigned to me.

2. Select the work items that will be delegated.

3. Click the Delegate work itemsDelegate work items menu.

4. In the UserUser  field, select the user to delegate the work items to.

5. In the CommentComment field, enter a comment that explains why you're delegating the work items.

6. Click the Delegate work itemsDelegate work items button to complete the work item delegation.

If you plan to be out of the office or otherwise unavailable to act on work items for a period of time, you can

automatically delegate new work items to other users using the User optionsUser options  page.

1. Go to Common > Setup > User optionsCommon > Setup > User options .

2. Click the WorkflowWorkflow  tab. Make sure the Delegation section is expanded. To configure the system to

automatically delegate your work items to other users, you must create delegation rules, which specify when

certain types of work items are delegated. Follow these steps to create a delegation rule.

3. Click AddAdd.

4. In the ScopeScope field, select an option:

5. In the NameName field:

6. In the DelegateDelegate field, select the user to delegate the work items to. Use the Star t date/timeStar t date/time and EndEnd

date/timedate/time fields to specify when you want the work items to be automatically delegated.

7. In the Star t date/timeStar t date/time field, enter a date and time.

8. In the End date/timeEnd date/time field, enter a date and time.

All – Delegate all work items that are assigned to you.

Module – Delegate only the work items that are related to a specific type of workflow. If you select this

option, you must select the type of workflow in the NameName field.

Workflow – Delegate only the work items that are related to a specific workflow. If you select this

option, you must select the workflow in the NameName field.

For ModuleModule scope, select the target module.

For WorkflowWorkflow  scope, select the target workflow.
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9. Select the EnabledEnabled check box to activate the delegation rule.

10. In the CommentComment field, enter a comment that explains why you're delegating the work items.
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This topic describes the steps to view the status of a document that was submitted to the workflow system for

processing and approval. The demo data company used to create this procedure is USMF.

1. Go to Navigation pane > Modules > Common > Inquir ies > Workflow > Workflow histor yNavigation pane > Modules > Common > Inquir ies > Workflow > Workflow histor y .

2. In the list, select the link in the desired row.

Use this form to view the status of a document that was submitted to the workflow system for

processing and approval.

The Instance IDInstance ID is the identification code of the workflow instance that is processing, or has

processed the document.

The StatusStatus  is the workflow status of the document.

The Workflow IDWorkflow ID is the identification code of the workflow that is processing, or has processed the

document.

The DocumentDocument is the identification code of the document.

The Document typeDocument type is the type of document that was submitted for processing.

The WorkflowWorkflow  is the name of the workflow that is processing, or has processed the document.

The VersionVersion is the version number of the workflow that is processing, or has processed the

document.

The Created date and timeCreated date and time is the date and time that the document was submitted.

The Elapsed timeElapsed time is the time that has passed since the document was submitted.

The ResumeResume button allows you to resume the workflow process for the selected document.

The RecallRecall  button allows you to recall the selected document so that it is not processed.

Make sure the Work itemsWork items section is expanded. In this section you can view the work items that are

associated with the selected document. For example, a task may have to be completed, or the

document may have to be approved.

The ReassignReassign button will open a dialog box where you can reassign a work item to another user.

Make sure the Tracking detailsTracking details  section is expanded. In this section you can view the workflow

history of the selected document.
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You can configure the system to send email messages to users when workflow-related events occur. For

example, email messages can be sent to users when documents are assigned to them for approval. The demo

data company used to create this procedure is USMF.

1. Go to Navigation pane > Modules > System administration > Users > UsersNavigation pane > Modules > System administration > Users > Users .

2. In the list, find and select the desired record.

3. On the Action paneAction pane, click User optionsUser options .

4. Click the WorkflowWorkflow  tab. Make sure that the NotificationsNotifications  section is expanded. In the NotificationsNotifications  section,

you can specify how you want the user to be notified about workflow-related events.

5. In the L ine-item workflow notification typeLine-item workflow notification type field, select an option.

6. Click SaveSave.

7. Close the page.

Grouped – Notifications for line items are grouped into a single email message.

Individual – An email message is sent for each line item.

If you want the user to receive notifications in the client, select the Send notifications in emailSend notifications in email

check box.

The workflow email templates will be sourced from either system email templates or organization email templates

depending on whether the workflow is a system-level (not company specific) or organization-level (company specific)

workflow.
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In this section

NOTENOTE

To add workflow support for a document, you must create a workflow type. After you create a workflow type, it

can be used to create workflow configurations for the document. This topic provides links to the procedures for

creating a workflow type.

You create workflow types to define the following elements:

The workflow document to assign the workflow to

A category that defines the module that the workflow type is available in

Tasks, automated tasks, and approvals that are supported for the workflow

The workflow started, completed, configuration data change, and canceled event handlers

A SubmitToWorkflowMenuItemSubmitToWorkflowMenuItem menu item

Workflow type checklist

Create a workflow category

Create a query for a workflow type

Create a new workflow type

Create a workflow document class

Create a SubmitToWorkflow class

Associate a workflow document class with a workflow type
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Workflow type checklist

Next steps

See also

This topic describes the steps that are required to create a new workflow type. Workflow types are used to

create configurations for a workflow.

1. If an existing category isn't appropriate, create a new workflow category to use for the workflow type. For

more information, see Create a workflow category.

2. Create a query that accesses the document that the new workflow type is being created for. For more

information, see Create a query for a workflow type.

3. Create a workflow type in Application Explorer. Typically, you complete this step by using the WorkflowWorkflow

wizard. For more information, see Create a new workflow type.

We recommend that you use the WorkflowWorkflow  wizard to create a workflow type. The wizard performs the

following tasks. In some cases, you must add more code for your workflow type. Links are provided so that you

can see the details of the actions that the wizard performs and the additional steps that you must perform to

complete your workflow type.

1. Create a workflow document class, and then bind the query that is used for the workflow to the class. For

more information, see Create a workflow document class.

2. Bind the workflow document class to the workflow type. For more information, see Associate a workflow

document class with a workflow type.

3. Create workflow event handlers for started, completed, configuration change, and canceled events, and then

bind event handlers to the workflow type. For more information, see Create a workflow event handler.

4. Create a class for SubmitToWorkflowMenuItemSubmitToWorkflowMenuItem. Optionally create a class for CancelMenuItemCancelMenuItem. Bind the

classes to the action menu items that you will create in the next step. For more information, see Classes and

methods.

5. Create an action menu item for the SubmitToWorkflowMenuItemSubmitToWorkflowMenuItem workflow property. Optionally create an

action menu item for the CancelMenuItemCancelMenuItem property. Bind the actions to the workflow type. For more

information, see Create a new workflow type.

After you create a workflow type, you can add tasks, automated tasks, and approvals.

Configure workflow properties

Configure manual tasks in a workflow

Configure automated tasks in a workflow

Configure approval processes in a workflow
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Create a workflow category

Bind a workflow type to a workflow category

When you create a workflow type, you must assign it to a workflow category. The workflow category

determines whether the workflow type is available in a specific module. If an appropriate workflow category

doesn't already exist, you must create it.

For example, a workflow type for a customer invoice should not be available in the Master planningMaster planning module.

To make the workflow type available only in the CustomerCustomer  module, select the CustomerCustomer  module when you

create a workflow category.

This topic describes how to create a workflow category.

P RO P ERT YP RO P ERT Y VA L UEVA L UE

Name Specify the name that is used to reference the workflow
category.

Label Specify the label that is used for the workflow category
in the user interface (UI).

Help Text Specify the description that is shown for the workflow
category in the workflow configuration UI.

Module Specify the module that the workflow will be available in.
The default module is LedgerLedger .

1. In Application Explorer, expand the Business Process and WorkflowBusiness Process and Workflow  node.

2. Follow one of these steps to create the workflow category:

Right-click the Workflow CategoriesWorkflow Categories  node, and then select New Workflow Categor yNew Workflow Categor y . A new

workflow category group appears under the Workflow CategoriesWorkflow Categories  node. Right-click the new

workflow category, and then select Proper tiesProper ties .

On the ProjectProject menu, select Add new itemAdd new item. In the Add new itemAdd new item dialog box, select WorkflowWorkflow

categor ycategor y . Enter a name for the category, and then select CreateCreate.

3. On the Proper tiesProper ties  sheet, set the following properties, as required.

After you create a workflow category, a workflow type can be bound to it. Typically, the WorkflowWorkflow  wizard

completes this step. However, the following procedure explains how to manually bind a workflow type to a

workflow category.

1. In Application Explorer, expand the Business Process and WorkflowBusiness Process and Workflow  node, and then expand the

Workflow TypesWorkflow Types  node.

2. Right-click the workflow type that you want to bind to a workflow category, and then select Proper tiesProper ties .

3. On the Proper tiesProper ties  sheet, set the Categor yCategor y  property to the workflow category that you created in the

previous procedure.
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Create a workflow type

Create a new workflow type
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Create a query for a workflow type
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Before you create a workflow type, you must create a query that will access the table fields for the workflow

document. This topic describes how to create a query for a workflow type.

1. Follow one of these steps to create a new query:

In Application Explorer, right-click the QueriesQueries  node, and then select New Quer yNew Quer y . A query group

appears under the QueriesQueries  node. Right-click the new query, and then select RenameRename. Enter a name

for the query.

On the ProjectProject menu, select Add new itemAdd new item. In the Add new itemAdd new item dialog box, select Quer yQuer y . Enter a

name for the query, and then select CreateCreate.

2. Expand the new query, right-click the Data SourcesData Sources  node, and then select New Data SourceNew Data Source. A data

source group appears under the Data SourcesData Sources  node.

3. Right-click the new data source group, and then select Proper tiesProper ties .

4. On the Proper tiesProper ties  sheet, set the TableTable property to the main table for the document type that you're

defining a workflow for.

5. In the Application Object Tree (AOT), right-click the new query, and then select SaveSave.

For more information about how to create queries, see Create queries by using the AOT.
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Create a new workflow type

To make the workflow process available for a workflow document, you must create the workflow types that are

used in the workflow configuration user interface (UI). This topic describes how to create a workflow type in

Application Explorer.

A workflow type defines the following information:

The document that the workflow is used for

Workflow categories, which are used to assign a workflow type to a specific module

Tasks, automated tasks, approvals, and line item workflows that the user can configure

Menu items and event handlers

VA L UEVA L UE DESC RIP T IO NDESC RIP T IO N

Name Specify the name that will be used for the workflow type.

Category Select the workflow category that will be used for the
workflow type. The category determines the module that
the workflow type is available in. You can use an existing
category or a new category that you create. For more
information, see Create a workflow category.

Query Select the query that will access the table fields for the
workflow document. For more information, see Create a
query for a workflow type.

Document menu item Select the menu item that points to the main page that
shows the document that you're creating the workflow
type for.

Document web menu item Select the web menu item that points to the Enterprise
Portal page that shows the document that you're
creating the workflow type for.

1. Follow one of these steps to open the WorkflowWorkflow  wizard. The wizard will help you create a new workflow

type.

In Application Explorer, right-click the Business Process and WorkflowBusiness Process and Workflow  node, and then select Add-Add-

InsIns  > Workflow type wizardWorkflow type wizard.

On the ProjectProject menu, select Add new itemAdd new item. In the Add new itemAdd new item dialog box, select WorkflowWorkflow

typetype. Enter a name for the query, and then select CreateCreate.

2. Set the following values for the wizard.

3. Specify the types of menu items that you want to create. You can create menu items, web menu items, or

both.

4. Select NextNext. A list of all the resources that will be created for the workflow type is shown.

5. Select FinishFinish to create the resources. The wizard creates classes, menu items, web menu items, the
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workflow type, and a project that contains all the items.

6. When dialog box appears that indicates the status, select OKOK. The project that contains the workflow type

resources is shown.

After you create a workflow type, the next step is to create a workflow document class to expose document data

for conditions. For more information, see Create a workflow document class.

Create a workflow type

Create a workflow category
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Create a workflow document class

You define table fields in a query to create workflow conditions. In a typical scenario, calculated fields are used to

determine the behavior of a workflow. For example, a dynamic sales total of all records in a table can be used as

a workflow condition to determine whether the step should be used. However, a limitation of queries is that you

can't define calculated fields in the queries themselves. To overcome this query limitation, you must use a

workflow document class. This topic describes how to create a workflow document class.

The workflow document class that you create defines table fields for conditions in two ways: the Application

Explorer query and parameter methods. You must override the getQuer yNamegetQuer yName method of the

WorkflowDocument class to return the name of the query. You can optionally add calculated fields by adding

parameter methods that have a specific signature on the class. For more information about workflow conditions,

see Configure workflow properties and Configure conditional decisions in a workflow.

The following procedures explain how to create a workflow document class that includes a parameter method

for a calculated field. Before you begin, you must create a query that specifies the data that will be accessed. For

more information about workflow queries, see Create a query for a workflow type.

If you used the WorkflowWorkflow wizard to create the workflow type, the wizard has already created the workflow document

class.

class <MyWorkflowDocumentClassName> extends WorkflowDocument
{
}

1. Follow one of these steps to create a new query:

In Application Explorer, expand the ClassesClasses  node. Right-click the ClassesClasses  node, and then select NewNew

ClassClass . A class group appears under the ClassesClasses  node. Right-click the new class, select RenameRename, and

then enter a name for the workflow document class.

On the ProjectProject menu, select Add new itemAdd new item. In the Add new itemAdd new item dialog box, select ClassClass . Enter a

name for the class, and then select CreateCreate.

2. Expand the new class, select classDeclarationclassDeclaration, right-click the class declaration, and then select EditEdit.

3. Enter the following code in the class declaration.

4. Close the EditorEditor  window, and select YesYes  to save your changes.

5. Right-click the new class, point to Overr ide MethodOverr ide Method, and then select getQuer yNamegetQuer yName. A method node

that is named getQuer yNamegetQuer yName appears under the workflow document class node, and the EditorEditor

window appears.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/workflow-type-document-create.md
https://docs.microsoft.com/en-us/previous-versions/dynamics/ax-2012/application-classes/gg798542(v=ax.60)
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QueryName getQueryName()
{
    return querystr(<MyWorkflowDocumentQueryName>);
}

Be sure to select getQuer yNamegetQuer yName as the method to override. The WorkflowDocument.getQuery method is used

only internally to retrieve the actual query, based on the string that is returned by the

WorkflowDocument.getQueryName method.

6. In the EditorEditor  window, enter the following code for the query method.

After you create the workflow document class, you can bind it to the workflow type. For more information, see

Associate a workflow document class with a workflow type.

You can add a calculated field to the workflow document class only if it meets these conditions:

It must be named parm <name>parm <name>.

It must define the CompanyIdCompanyId, TableIdTableId, and RecIdRecId parameters.

It must return an extended data type (EDT) that will be included in the list of fields that define conditions or

notification messages. The label for the EDT must uniquely identify the value.

public TotalJournalCreditAmount parmTotalJournalCreditAmount(CompanyId _companyId, TableId _tableId, 
RecId _recId)
{
    // The calculateAmounts method contains business and validation logic
    this.calculateAmounts(_companyId, _tableId, _recId);
    return totalJournalCreditAmount;
}

1. In the workflow document class that you want to add a calculated field to, right-click the class, and then

select New MethodNew Method. A new method node appears under the ClassesClasses  node.

2. Right-click the new method node, and then select EditEdit.

3. Enter code in the format that is shown in the following example. This example shows how to add a

calculated field to determine the total credit amount for a journal.

Associate a workflow document class with a workflow type

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a SubmitToWorkflow class

A workflow is started when the user selects the SubmitSubmit button on the workflow toolbar. The SubmitSubmit button is

bound to an action menu item that calls the mainmain method of a class that you create to activate a workflow. This

topic describes how to create a SubmitToWorkflowSubmitToWorkflow  class and use the name of the workflow type to activate

the workflow.

You can also activate a workflow by using the workflow configuration ID or the workflow sequence number. The

basic procedure is the same. For more information, see Activating a workflow.

If you used the WorkflowWorkflow wizard to create the workflow type, the wizard has already created a workflow submission

manager class. You just have to add code to it.

NOTENOTE

1. In Application Explorer, expand the ClassesClasses  node.

2. Right-click the ClassesClasses  node, and then select New ClassNew Class . A class group appears under the ClassesClasses

node.

3. Right-click the new class, and then select New MethodNew Method. A new method node appears under the ClassesClasses

node.

4. Right-click the new method, and then select EditEdit.

5. Enter the following code for the mainmain method to use the name of the workflow type to activate the

workflow.

This example applies to workflow submissions. For an example that also works with Enterprise Portal, see Adding

enterprise portal support for workflow submission.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/workflow-type-submit-to-workflow.md
https://docs.microsoft.com/en-us/dynamicsax-2012/developer/activating-a-workflow
https://docs.microsoft.com/en-us/dynamicsax-2012/developer/adding-enterprise-portal-support-for-workflow-submission
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public static void main(Args args)
{
    // Variable declaration.
    recId _recId = args.record().RecId;
    WorkflowCorrelationId _workflowCorrelationId;
    // Hardcoded workflow type name.
    WorkflowTypeName _workflowTypeName = workflowtypestr("MyWorkflowType");
    // Initial note is the information that users enter when they
    // submit the document for workflow.
    WorkflowComment _initialNote = "";
    WorkflowSubmitDialog workflowSubmitDialog;
    // Opens the submit to workflow dialog box for user comments.
    workflowSubmitDialog = 
WorkflowSubmitDialog::construct(args.caller().getActiveWorkflowConfiguration());
    workflowSubmitDialog.run();
    if (workflowSubmitDialog.parmIsClosedOK())
    {
        _recId = args.record().RecId;
        // Get user comments from the submit to workflow dialog box.
        _initialNote = workflowSubmitDialog.parmWorkflowComment();
        try
        {
            ttsbegin;
            // Activate the workflow from a template.
            _workflowCorrelationId = Workflow::activateFromWorkflowType(_workflowTypeName, _recId, 
_initialNote, NoYes::No);
            ttscommit;
            // Updates the workflow button to display Actions instead of Submit.
            args.caller().updateWorkflowControls();
        }
        catch(exception::Error)
        {
            // ToDo Insert your error code here.
        }
    }
}

NOTENOTE

6. Close the EditorEditor  window, and select YesYes  to save your changes.

When you save this code, you will receive an "Empty compound statement" warning message in the CompilerCompiler

OutputOutput  window unless you add valid code in the catch(exception::Error)catch(exception::Error) block.

Activating a workflow

Create a new workflow type

Workflow::activateFromWorkflowType method

Workflow::activateFromWorkflowSequenceNumber method

Workflow::activateFromWorkflowConfigurationId method

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Bind a workflow document class to a workflow type

See also
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To create a workflow, you must bind a workflow document class to the workflow type. The workflow document

class contains references to the table data fields that the workflow uses. This topic describes how to bind a

workflow document class to a workflow type.

If you used the WorkflowWorkflow wizard to create the workflow type, the wizard has already bound the workflow document class

to the workflow type.

Before you begin the following procedure, you must create a workflow document class to expose the table fields

that are used for conditions in the configuration user interface (UI). For more information, see Create a workflow

document class.

1. In Application Explorer, expand the WorkflowWorkflow  node.

2. In the Workflow TypesWorkflow Types  node, right-click the workflow type that you want to bind a workflow document

class to, and then select Proper tiesProper ties .

3. On the Proper tiesProper ties  sheet, set the DocumentDocument property to the workflow document class that defines the

workflow document.

Create a new workflow type

Create a workflow document class

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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This topic points you to a report that lists the available workflow types.

To create a workflow, you must first select the type of workflow that you want to create. For example, you may

want to create a Purchase requisition line reviewPurchase requisition line review  workflow to define who must approve line items on

purchase requisitions. For more information about creating a workflow, see Create workflows overview.

The Workflow types repor tWorkflow types repor t, included with the Technical reference reports, lists each type of workflow that is

available. The report also describes what each type of workflow is used for and indicates whether the workflows

of each type are associated with a specific company in the organization or with the whole organization.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/workflow-types-report.md
https://docs.microsoft.com/en-us/dynamics/s-e/global/axtechrefrep_61
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Workflow FAQ
2/18/2021 • 3 minutes to read • Edit Online

Why are multiple notifications received when a work item is rejected?

Why are my workflow exports failing?

Can the submitter of a workflow also approve the workflow?

Can I add alerts to workflows to provide notifications to users?

This topic answers frequently asked questions about the workflow system.

When a work item is rejected, that work item is completed as rejected. Another work item is created and

assigned to the originator. This means that there is a notification to the originator for the rejected work item, and

a separate notification to the user assigned to the new "change requested" work item.

Each notification is for a different work item, but the similarity can cause confusion. We are looking at ways to

improve this in a future release.

There is currently a limitation in the workflow export feature that prevents workflow names from exceeding 48

characters. Using a name that is longer than 48 characters can result in a "Server failed to authenticate the

request" error and/or prevent a file to be exported without a file type. The following blog post provides more

details, Workflow export troubleshooting.

Yes, a submitter of a workflow can also approve the workflow if it is configured that way. To prevent this

behavior, set System administration > Workflow > Workflow parameters > General > Approver >System administration > Workflow > Workflow parameters > General > Approver >

Disallow approval by submitterDisallow approval by submitter  to YesYes .

Here are a few key areas to note about adding alerts to workflows to provide notifications:

Alerts versus workflow notification mechanisms

Standard notifications from workflows

Adding notifications to workflows

Alerts can be set up for record changes. Workflows change records, so it's possible to set up an alert

related to a record change caused by a workflow. However, because workflows have different built-in

notification options, using alerts isn’t ideal.

Workflows have built in email notifications. A customer can configure the notifications so that the

users are sent emails. Those notifications don’t result in Action Center messages for users.

In a future update we will be adding an Action Center message so a user is assigned a workflow work

item.

Action Center messages can be created for specific users, such as a message created from a workflow

in X++.

Workflows have business events that the customer could use to trigger Flows have the notifications

that they are looking for.

In summary, if a user does not get the proper notification from the Action Center when they are assigned a

workflow work item, then leverage Workflow business events with Microsoft Power Automate to provide

additional or different notifications.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/workflow-FAQ.md
https://community.dynamics.com/ax/b/elandaxdynamicsaxupgradesanddevelopment/archive/2019/04/10/workflow-export-troubleshooting
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/business-events/business-events-workflow
https://docs.microsoft.com/en-us/dynamics365/unified-operations/dev-itpro/business-events/business-events-workflow


Why is workflow editor not able to start under AD FS?

Why am I getting SQL deadlocks on workflow processing?

What is the Workflow Enhanced Error feature?
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When running under Active Directory Federation Services (AD FS) in an upgraded environment, the workflow

editor may have trouble starting. If it does, make sure that the URL "https://dynamicsaxworkfloweditor/" is

added to the property Microsoft Dynamics 365 for Operations On-premises - Workflow - NativeMicrosoft Dynamics 365 for Operations On-premises - Workflow - Native

applicationapplication in the ADFS settings.

The default field value for the Number of workflow items per batchNumber of workflow items per batch on the Workflow parametersWorkflow parameters  page is

0. A value of 0 causes the default to change to 20 items per batch. Be careful when adjusting this value because

a high number of items per batch (> 40) can cause SQL deadlocks.

The Workflow Enhanced Error feature in version 10.0.13 adds error codes to differentiate different classes of

workflow errors. The error messages reported will be mostly similar with minor differences to make them

clearer.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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About alerts

Scenario 1: Create an alert rule for new sales ordersScenario 1: Create an alert rule for new sales orders

Scenario 2: Create an alert rule for postponement of a delivery dateScenario 2: Create an alert rule for postponement of a delivery date

What occurs when an alert rule is created?

Preparing for an alert

Alerts form a notification system for critical events in the system. You can use alerts to stay informed about

events that you want to track during the workday. You can easily create your own set of alert rules so that you're

alerted about deliveries that are overdue, orders that are deleted, prices that change, or other events that you

must respond to.

In enterprise resource planning (ERP), there are several typical scenarios where the alerts feature can be used.

Here are some examples.

1. Open the All sales ordersAll sales orders  page.

2. On the Action Pane, on the OptionsOptions  tab, in the ShareShare group, select Create a custom aler tCreate a custom aler t.

3. In the Create aler t ruleCreate aler t rule dialog box, on the Aler t me whenAler t me when FastTab, in the EventEvent field, select Record hasRecord has

been createdbeen created.

1. Open the All purchase ordersAll purchase orders  page.

2. Select a purchase order ID to access the purchase order details.

3. Expand the Purchase order headerPurchase order header  FastTab.

4. On the Action Pane, on the OptionsOptions  tab, in the ShareShare group, select Create a custom aler tCreate a custom aler t.

5. In the Create aler t ruleCreate aler t rule dialog box, on the Aler t me whenAler t me when FastTab, in the FieldField field, select Deliver y dateDeliver y date.

6. In the EventEvent field, select has been postponedhas been postponed.

After you close the Create aler t ruleCreate aler t rule dialog box, your rule appears on the Manage aler t rulesManage aler t rules  page. You can

use the Manage aler t rulesManage aler t rules  page to update your existing alert rules. For example, you can modify event

triggers, update event notifications, and update expiration dates. To open the Manage aler t rulesManage aler t rules  page, use the

Aler t meAler t me button on the OptionsOptions  tab of the Action Pane.

When you create alert rules, you can associate a predefined event with a specific field. For example, the date that

is specified in the field arrives, or the contents of the field change. Alternatively, you can associate an event with

the records on a specific page. For example, a record is created, or a record is deleted.

When the selected event occurs for the field or for a record on the page, an alert is sent to you. For example, you

create a rule where you associate the Deliver y dateDeliver y date field on a specific purchase order line with the was duewas due

this amount of time agothis amount of time ago event. You set the time frame to five days. In this case, an alert is sent five days after

the delivery date of that purchase order line.

Additionally, you can refine alert rules by setting conditions. For example, you can be alerted about new

purchase orders that are created for specific vendor accounts.

Before you set up an alert rule, decide when or in what situations you want to receive alerts. When you know

which event you want to be notified about, find the page where the data that causes that event appears. The

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/alerts-overview.md


Components of an alert rule

Videos
How to use alerts to monitor filtered dataHow to use alerts to monitor filtered data

Alert rule optionsAlert rule options
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event can be a date that arrives or a specific change that occurs. Therefore, you must find the page where the

date is specified, or where the field that changes or the new record that is created appears. After you have this

information, you can create the alert rule.

An alert rule has five components:

NOTENOTE

EventEvent – The event that triggers an alert rule can be a date that arrives or a specific change that occurs.

You define events on the Send email aler ts for job status changesSend email aler ts for job status changes  FastTab of the Create aler t ruleCreate aler t rule

dialog box.

ConditionCondition – On the Aler t me forAler t me for  FastTab of the Create aler t ruleCreate aler t rule dialog box, you can select the scope

of the condition, to control when you're alerted about events. You can apply the rule either to the current

record only or to all visible records on the page. If the rule applies across legal entities, you can set the

Organization-wideOrganization-wide option to YesYes .

Expir y of ruleExpir y of rule – On the Aler t me untilAler t me until  FastTab of the Create aler t ruleCreate aler t rule dialog box, you can specify

how long the alert rule should be active.

ContentsContents  – On the Aler t me withAler t me with FastTab of the Create aler t ruleCreate aler t rule dialog box, you can specify the

subject text and message text that the alert messages should use.

UserUser  – On the Aler t whoAler t who FastTab of the Create aler t ruleCreate aler t rule dialog box, you can specify which user

should receive the alert messages. By default, your user ID is selected.

This option is restricted to organization administrators.

The How to use alerts to monitor filtered data video (shown above) is included in the Finance and Operations

playlist available on YouTube.

The Alert rule options video (shown above) is included in the Finance and Operations playlist available on

YouTube.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Getting started

Ensure the alert batch jobs are running

Events

Event types

Conditions

Before you set up an alert rule, decide when or in what situations you want to receive alerts. When you know

which event you want to be notified about, find the page where the data that causes that event appears. The

event can be a date that arrives or a specific change that occurs. Therefore, you must find the page where the

date is specified, or where the field that changes or the new record that is created appears. After you have this

information, you can create the alert rule.

When you create an alert rule, you define the criteria that must be met before an alert is triggered. Criteria is

basically the match between the occurrence of an event and the fulfillment of specific conditions. When an event

occurs, the system starts to perform a check according to the conditions that are set up.

The batch jobs for data change and due date alerts need to be running for the alert conditions to be processed

and the notifications to be sent. To run batch jobs, go to System administrationSystem administration > Periodic tasksPeriodic tasks  > Aler tsAler ts

and add a new batch job for Change based aler tsChange based aler ts  and/or Due date aler tsDue date aler ts . If a long and frequently running

batch job is needed, select RecurrenceRecurrence and set No end dateNo end date with a Recurrence patternRecurrence pattern of MinutesMinutes  and a

CountCount of 11 .

The event that triggers an alert rule can be a date that arrives or a specific change that occurs. Triggers for

events are defined on the Aler t me whenAler t me when FastTab of the Create aler t ruleCreate aler t rule dialog box. The events that are

available for a particular field depend on the trigger that is selected.

For example, if you're setting up an alert rule for the Star t dateStar t date field, due date events are appropriate.

Therefore, the is due in  event type is available for that field. However, for a field such as Cost centerCost center , a due

date event isn't appropriate. Therefore, the is due in  event type isn't available. Instead, the has changed  event

type is available.

Three types of events can occur :

Create-type and delete-type eventsCreate-type and delete-type events  – These events trigger an alert when a record is created or deleted.

Update-type eventsUpdate-type events  – These events trigger an alert when the data in a specific field changes.

Due date-type eventsDue date-type events  – These events trigger an alert when a date arrives.

Changes that occur can be initiated by a user. For example, a user changes the delivery date of a purchase order.

Alternatively, changes can occur as part of a process. For example, the StatusStatus  field on a page changes to reflect

the life cycle of various processes in the system.

On the Aler t me forAler t me for  FastTab in the Create aler t ruleCreate aler t rule dialog box, you can use conditions to control when

you're alerted about events.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/create-alerts.md
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Alert contents

User ID

Alerts as business events

Create an alert rule

For example, you can specify that the system should alert you when the status of purchase orders changes, but

only if the status matches a specific set of conditions. Specifically, you want to be alerted when the status of a

purchase order is set to ReceivedReceived. This change in status is the event that triggers the alert.

Next, you must decide which purchase orders you want to be alerted about. For example, you can select one of

the following options. These options define the conditions for the alert rule.

Current selected recordCurrent selected record – You receive an alert when the status of a specific purchase order changes to

ReceivedReceived.

All recordsAll records  – You receive an alert when the status of a purchase order is changed for an item in the active

page view. You can use the advanced filtering that is available on the page to create rules for a specific set of

records. For example, you can create an alert that is triggered for all purchase orders for the customers in a

specific customer group.

On the Aler t me untilAler t me until  FastTab of the Create aler t ruleCreate aler t rule dialog box, you can specify how long the alert rule

should be active.

On the Aler t me withAler t me with FastTab of the Create aler t ruleCreate aler t rule dialog box, you can specify the subject text and

message text that the alert messages should use.

On the Aler t me withAler t me with FastTab of the Create aler t ruleCreate aler t rule dialog box, you can specify which user should receive

the alert messages. By default, your user ID is selected. The ability to change the user receiving the alert is

restricted to organization administrators.

You can send alerts externally using the business events framework. When creating an alert, set Organization-Organization-

widewide to NoNo and set Send externallySend externally  to YesYes . After you have the alert triggering the business event, you can

trigger a flow built in Power Automate using the When a business event occursWhen a business event occurs  trigger on the Finance and

Operations connector, or explicitly send the event to a business events endpoint via the Business eventsBusiness events

catalogcatalog.

0. Ensure the alert batch jobs are running (see above).

1. Open the page that contains the data to monitor.

2. On the Action Pane, on the OptionsOptions  tab, in the ShareShare group, select Create aler t ruleCreate aler t rule.

3. In the Create aler t ruleCreate aler t rule dialog box, in the FieldField field, select the field to monitor.

4. In the EventEvent field, select the type of event.

5. On the Aler t me forAler t me for  FastTab, select the desired option. If you want to send the alert as a business event, set

the Organization-wideOrganization-wide value to NoNo.

6. If the alert rule should become inactive on a specific date, on the Aler t me untilAler t me until  FastTab, select an end date.

7. On the Aler t me withAler t me with FastTab, in the SubjectSubject field, accept the default subject heading for the email

message, or enter a new subject. The text becomes the subject heading for the email message that you

receive when an alert is triggered. If you want to send the alert as a business event, set Send externallySend externally  to

YesYes .

8. In the MessageMessage field, enter an optional message. The text becomes the message that you receive when an



Limitations and workarounds
Workaround for creating alerts for the secondary data sources of a formWorkaround for creating alerts for the secondary data sources of a form
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alert is triggered.

9. Select OKOK to save the settings and create the alert rule.

You can't create alerts for some secondary data sources on forms. For example, when creating alerts on the

customer or vendor posting profiles form, only the fields on the header (CustLedger or VendLedger) are

available and not the dimension accounts. The workaround for this limitation is to use SysTableBrowserSysTableBrowser  to

open that table as primary data source.

1. Open the table in the SysTableBrowserSysTableBrowser  form.

 https://<EnvironmentURL>/?cmp=USMF&mi=SysTableBrowser&TableName=<TableName>

2. Create an alert from the SysTableBrowser form.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Batch processing for change-based events

Frequency for change-based eventsFrequency for change-based events

The risks of low batch frequencyThe risks of low batch frequency

Set up processing for change-based alertsSet up processing for change-based alerts

Alerts are processed by the batch processing functionality. You must set up batch processing before the process

and deliver alerts.

Batch processing functionality supports two types of events:

Events triggered by change-based events. These events are also referred to as create/delete and update

events.

Events triggered by due dates.

You can set up batch processes for each type of event.

The system reads all change-based events that have occurred since batch processing was last run. Change-

based events include updates to fields, the deletion of records, and the creation of records. These events are

compared with the conditions that you set up in alert rules. When an event matches the conditions in a rule, the

batch process generates an alert.

For change-based events, you can set up a batch job that triggers the processing of an event soon after the

system logs the event. If you set up the batch job to recur more often, users receive their alerts sooner after

changes occur. However, a high frequency for batch processing might adversely affect system performance.

On the other hand, a batch job that recurs less often, and that you schedule for times when the system load is

low, might help improve system performance. However, a low frequency for batch processing might not meet

the users' demands for timely alerts.

Therefore, when you set up the frequency of batch processing for change-based events, consider the balance

between the timeliness of alerts and the performance of the whole system. These considerations become more

relevant as the number of users who create alert rules increases. The frequency doesn't affect the number of

events that the system processes. However, if more users create rules, the process runs more checks. This type of

data exchange might affect system performance.

If you set up a low frequency for batch processing for change-based events, data that is relevant to the

conditions in alert rules might change before processing. Therefore, you might lose alerts.

For example, you create an alert to trigger when the event is customer contact changescustomer contact changes  and the condition is

customer = BBcustomer = BB. In other words, when the customer contact for customer BB changes, the process logs the

event. However, the batch processing system is set up so that batch processing occurs less often than data entry.

If the customer name changes from BBBB to AAAA before the event is processed, the data in the database no longer

matches the condition in the rule, customer = BBcustomer = BB. Therefore, when the event is finally processed, no alert is

generated.

1. Go to System administrationSystem administration > Periodic tasksPeriodic tasks  > Aler tsAler ts  > Change based aler tsChange based aler ts .

2. In the Change based aler tsChange based aler ts  dialog box, enter the appropriate information.
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The system detects all events that are caused by due dates, and these events are compared with the conditions

that are set up in alert rules. The batch process generates an alert when an event matches the conditions in a

rule.

For due-date events, you might want to set up batch jobs that are run during the night or at specific times of the

day, to balance the system load. We recommend that you set up the batch job so that it's run at least one time

per day. If alerts should be sent as early as possible, set up the batch processing to occur immediately after the

system date changes. If you want to generate alerts for due-date events that occur after a batch job has already

processed alerts, you can run the batch job again on the same day.

For example, a batch job has been run on a particular day. You then create a purchase order that has a due date

that should trigger an alert on that same day. To receive the alert on that day, you must run the batch job again

after the purchase order is created. However, if you don't run the batch job again on that day, the next day's

batch job detects any due-date events that weren't processed on previous days.

Even when the batch process is run more than one time per day, alerts aren't duplicated for the same due-date event and

conditions. Alerts are generated only for dates that have become due because of changes that occurred in the system

after the last batch job was run.

The processing of alert rules in a company can be stopped for several reasons. These reasons include vacations,

system errors, or other issues that prevent the batch jobs from being run for some time.

To prevent due-date alerts from becoming obsolete because the batch job hasn't been run for several days, you

can set up a batch processing window. A batch processing window can be used to prevent a batch job from

being run for a specified number of days.

If you set up a batch processing window, an alert is sent when the alert rule is processed, even if the alert

exceeds the time limit that is defined in the due-date criteria. An alert continues to be sent for as long as the

period that is defined by this time limit plus the batch processing window isn't exceeded. However, when the

period exceeds the value defined by the time limit plus the batch processing window, an alert is no longer sent.

1. Go to System administrationSystem administration > Periodic tasksPeriodic tasks  > Aler tsAler ts  > Due date aler tsDue date aler ts .

2. In the Due date aler tsDue date aler ts  dialog box, enter the appropriate information.
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Alert notification email templates

You can define custom alert rules that monitor filtered views of data and automatically send email notifications

when predefined events occur. The option to send email notifications is available for all supported alert types

and you can also turn them on for existing alert rules.

You can use built-in controls to create alert rules that monitor the filtered views of system batch jobs. By

monitoring the value of the StatusStatus  field, you can also configure alert rules that send email when a batch job

fails. After you create these alert rules, you no longer have to check reports for changes to business data.

Instead, you can let the intelligent change detection service do the monitoring for you.

Client alerts depend on the email subsystem that is provided through integration with Microsoft Office. We

recommend that you use the Simple Mail Transfer Protocol (SMTP) provider, so that email distribution doesn't

have to rely on a local mail client.

To send notifications by email, customers must configure integrated email services. Email notifications are sent

to recipients on behalf of alert owners.

For more information about how to configure email, see Configure and send email.

The following image shows the Create aler t ruleCreate aler t rule dialog box, which now includes a Send emailSend email  option.

When the Send emailSend email option is set to YesYes , alert notifications will continue to be delivered from the Action Center.

The service sends email notifications by using predefined email templates that deliver the basic details of the

alert notification.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/get-started/alert-email-notifications.md
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The following image shows the structure of the alert notifications when they are received by email.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Electronic signatures

Users who require access to electronic signatures

Electronic signature administratorElectronic signature administrator

SignerSigner

This article provides an overview of electronic signatures and describes how they can be used.

An electronic signature confirms the identity of a person who is about to start or approve a computing process.

In some industries, an electronic signature is as legally binding as a handwritten signature.

Electronic signatures are a regulations compliance requirement for several regulated industries, such as

pharmaceuticals, food and beverage, and aerospace and defense. They are also required for compliance with

regulations in 21 CFR Part 11 that was issued by the Food and Drug Administration (FDA) in the United States.

An electronic signature by itself isn't the same as a digital signature. An electronic signature is just a substitute for a

handwritten signature, whereas a digital signature provides additional security measures. A digital signature can help

identify whether another user or process has tampered with the data. A digital signature can also be verified, and this

verification can't be refuted by the owner of the certificate that was used to sign the data. As described below, electronic

signatures have built-in digital signature functionality.

You can use electronic signatures for critical business processes. Some processes have built-in electronic

signature capabilities. You can also create custom signature requirements for any database table and field.

Electronic signatures have built-in digital signature functionality. Every user who signs documents must obtain a

valid cryptographic certificate. When a document is signed, the private key that is associated with that certificate

is validated. Electronic signature information is recorded in a log to provide an audit trail. To set up electronic

signatures, see Set up electronic signatures.

Three kinds of users typically require security access to electronic signatures: electronic signature

administrators, signers, and electronic signature auditors.

The electronic signature administrator sets up signature requirements, general parameters, and approvers, and

receives alerts when signatures can't be verified. By default, a user who belongs to the InformationInformation

technology managertechnology manager  security role has permission to administer electronic signatures.

A signer provides electronic signatures for documents and processes that require signatures. By default, a user

who belongs to the System userSystem user  security role has permission to sign documents electronically.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/electronic-signature-overview.md
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Sign for another user's changesSign for another user's changes

The signer might require additional permissions before access is granted to data that is related to the document or

process that is being signed. A user who changes data and must then sign for those changes must have permission to

change the data. A user who signs on behalf of another user might not require access to the data. An example of this kind

of user is a supervisor who signs for an employee's changes.

The electronic signature auditor reviews the database log and the signature review log that is available from the

database log. By default, a user who belongs to the Information technology managerInformation technology manager  security role has

permission to audit electronic signatures.

If you use a role other than Information technology managerInformation technology manager , make sure that the role is assigned the

following privileges:

View electronic signature failures

View database log

Before you sign documents electronically, you must request a certificate.

Microsoft SQL Server features are used to create certificates and enable electronic signing. No additional certificate or

public key infrastructure (PKI) is required.

When you request a certificate, a public key and a private key are created for you. The private key is encrypted

by using a password that is known only to you. When you sign a document electronically, your identity is

verified when you enter the password.

To request a certificate, on the OptionsOptions  page, on the AccountsAccounts  tab, click Get cer tificateGet cer tificate.

You must enter and confirm the password that you will use for signing. The password is used to protect your

private key and authorize the use of your certificate. This password isn't stored in the database, and it isn't

available to anyone else, not even to the administrator.

If you forget the password that is connected with your certificate, that certificate must be reset. If you reset the

certificate, you don't affect documents that you signed by using the previous certificate. To reset the certificate,

on the OptionsOptions  page, click Reset cer tificateReset cer tificate.

The S ign documentSign document page is displayed when you make a change that requires an electronic signature.

1. On the S ign documentSign document page, click the DocumentDocument tab to review the changes to the document.

2. On the S ignatureSignature tab, select a reason code.

3. Enter a comment, if a comment is required.

4. If your user ID doesn't appear in the S ignerSigner  field, select it in the list.

5. Enter your location, if this information is required.

6. Click OKOK.

Occasionally, you might want a user to sign for another user's changes. For example, a supervisor might be
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required to sign for changes that an employee makes to a bill of materials (BOM). Use this procedure to

designate a user as a signer for another user.

When one user signs for another user's change, the signature must be provided at the workstation of the user who made

the change. The user can't save the change until the signature has been provided.

To designate approvers, follow these steps.

1. On the OptionsOptions  page, on the AccountsAccounts  tab, click Designate approverDesignate approver .

2. In the Approver user IDApprover user ID field, select the ID of the user who must sign for another user's changes.

3. In the S ign for user IDSign for user ID field, select the ID of the user whose changes must be signed for.

Can you tell us about your documentation language preferences? Take a short survey.
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Enable the Electronic signature configuration key

Set up electronic signature parameters

Set up reason codes for electronic signatures

Require electronic signatures for existing processes

Use this procedure to set up electronic signatures. An electronic signature confirms the identity of a person who

is about to start or approve a computing process. The demo data company used to create this procedure is DAT.

1. Go to System administration > Setup > License configuration.

2. In the tree, expand 'Administration'.

3. Close the page.

Verify that the Electronic signature check box is selected.

If the Electronic signature check box is not selected, you must enable maintenance mode. Maintenance

mode can be enabled in this environment by running a maintenance job from Lifecycle Services, or by

using the Deployment.Setup tool locally.

1. Go to Organization administration > Setup > Electronic signature > Electronic signature parameters.

2. Click Edit.

3. In the Notice field, type a value.

4. Click Save.

5. Close the page.

Enter the notice that signers will receive when a signature is requested. You can enter any text.

Typically, this text tells the user what it means to sign a document electronically.

If you want to enter the Notice text in additional languages, click the Translations button.

1. Go to Organization administration > Setup > Electronic signature > Electronic signature reason codes.

2. Click New.

3. In the Reason code field, type a value.

4. In the Description field, type a value.

5. Click Save.

6. Close the page.

You must set up reason codes before using electronic signatures. A valid reason code is required when

signing a document. A signer selects a reason code to indicate the purpose of an electronic signature.

For example, a reason code could be used to indicate legal approval.

Enter additional reason codes, if needed.

1. Go to Organization administration > Setup > Electronic signature > Electronic signature requirements.

2. In the list, find and select the desired record.

3. Select or clear the Signature required check box.

Select a process that requires electronic signatures.

Repeat these steps for each process that requires electronic signatures.
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4. Click Save.

1. Click New.

2. Select or clear the Signature required check box.

3. In the Name field, enter a name for the process that requires electronic signatures.

4. In the Table name field, click the drop-down button to open the lookup.

5. In the list, find and select the table where the data that must be signed is stored.

6. In the list, click the link in the selected row.

7. In the Field name field, click the drop-down button to open the lookup.

8. In the list, find and select the field in the table that you want to monitor.

9. In the list, click the link in the selected row.

10. Click Save.

11. Close the page.

Specify when a signature is required. Select Always if a signature is required when the data in the field

changes. Select Only if a signature is required only under certain conditions. If you select Only, you

must also select one of the following options: When a record is inserted, When a record is updated, or

When a record is deleted.

Can you tell us about your documentation language preferences? Take a short survey.
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Example: How Fabrikam uses cases for customers in the private sector

Example: How City Power & Light uses cases for customers in the
public sector

By planning, tracking, and analyzing cases, you can develop efficient resolutions that can be used for similar

issues. For example, when customer service representatives or Human Resources generalists create cases, they

can find information in knowledge articles to help them work more efficiently. The following examples show

how cases can be used for different situations in an organization.

Lisa, a customer service representative at Fabrikam, receives a telephone call from Lionel, a Fabrikam customer.

Lionel is having trouble setting the correct volume level on the new sound system that Fabrikam installed in his

music store. Lisa creates a case for Lionel and assigns the VolumeVolume category to the case. Lisa then elevates the

priority and assigns a one-day service level agreement (SLA) to the case.

Lisa also enters the case details in the case log. Lisa notices that several knowledge articles are associated with

the VolumeVolume category, and that three of them are marked as helpful for resolving cases. Lisa opens each article

and discusses the resolution steps with Lionel, but none of the solutions solve the issue that Lionel is having

with the new sound system. Lisa tells Lionel that an audio technician will call him within 24 hours and work to

solve the issue.

Lisa activates the case, and a set of activities is created. She assigns the activities to Terrence, a member of the

audio engineering team. Terrence sees that new activities are assigned to him. He opens the case and reads the

case log to learn more about the case. Terrence encountered the same issue the day before, and he developed a

solution. Terrence contacts Lionel and offers this solution for the issue. Terrence also enters it in the case details.

Because his solution is successful, Terrence decides to document it, so that other people can use it if they

encounter the same issue. Terrence adds the document to the Knowledge ar ticleKnowledge ar ticle page, assigns the document

to the VolumeVolume category, and manually elevates the ranking, so that other Fabrikam employees will know that

it's a successful solution. Terrence then elevates the case to the next level. By elevating the case, he creates a new

activity for Marie, who is a quality assurance representative in the customer service department.

Marie sees that a new activity is assigned to her, and opens the case that is associated with the activity. Marie

reviews the case and the case details to make sure that the correct process was followed for the case. Marie

verifies that the actual case time did not exceed the time frame that was estimated in the SLA. Marie notes that

Terrence contacted the customer, and that the issue was resolved. Marie is satisfied with the treatment that the

customer received and the results of the case. She resolves the case as closed. When Marie closes the case, the

open activity that is assigned to her is also closed.

Annie, a customer service representative with City Power & Light, receives a telephone call from a resident of

the city that City Power & Light serves. Annie records the call as an activity and takes notes of the conversation.

The resident tells Annie that his house has no power. Annie informs the resident that City Power & Light will

investigate, find, and resolve the issue as quickly as possible.

Annie then creates a case, associates the telephone call with the case, and creates a service order. Annie knows

that other residents are likely to call to report a power outage. Therefore, to avoid overwhelming the customer

service center, and to save time, Annie sends a group instant message (IM) to inform the other representatives

about the issue, and to tell them that a case and service order have been created. Annie includes the case

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/cases.md
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number and service order number in her IM. Then, if City Power & Light receives more telephone calls about the

power outage, the customer service representatives can create an activity for each telephone call and assign it to

the existing case.

The following scenarios show how Fabrikam Human Resources generalists in different locations can use case

management when they address issues for employees.

Christine, the Human Resources generalist for the Great Britain division of Fabrikam, receives a telephone call

from Peter, a Fabrikam employee. Peter informs Christine that nine weeks ago, immediately after the birth of his

son, he changed the number of dependents on his tax withholdings. Peter wants to know why the changes

haven't become effective. Christine creates a case for Peter. She reviews Peter's tax information and learns that,

although Peter entered new dependent information, he didn't select a start date for the new tax withholdings.

Christine sends an email message to inform Peter that he must select a start date and resubmit his changes.

Peter replies to Christine's message to tell her that he has now selected a start date and resubmitted his changes.

Christine attaches the email message from Peter to the case record, verifies that the correct changes were made

and submitted, and closes the case.

Luke, the Human Resources generalist for the United States division of Fabrikam, receives an email message

from Shannon, a Fabrikam employee. Shannon is a machine operator who was injured on the job six months

ago. Since then, she has been working with Humongous Insurance to have her medical expenses paid. Because

Shannon contacted Luke about this issue four weeks ago, a case has already been created. Shannon's new email

message explains that Humongous Insurance is still not returning her telephone calls. Luke opens the existing

case, adds Shannon's email message as a document, and reviews the case log. When Luke created this case, he

assigned the InsuranceInsurance category to it. He now sees that there is a new knowledge article that is associated with

the InsuranceInsurance category. Luke reads the knowledge article and learns that all phones at Humongous Insurance

are down while the company's telephone system is being updated. The article states that the insurance company

sent an email message to all its customers, but that several customers did not receive the message because of a

problem with the company's email system. All customers who have active insurance claims are asked to send

their inquiries to Humongous Insurance by email or paper mail. Luke sends Shannon an email message that

explains what she must do to have her insurance claim settled. He also ranks the knowledge article that he read

as a helpful source of information. Luke creates another activity for himself, so that he can follow up with both

Shannon and Humongous Insurance in four weeks to make sure that the claim has been resolved. After four

weeks, Luke contacts Shannon. He learns that Humongous Insurance has paid her claims, and that she is happy

with the resolution. Luke changes the status of the case to ClosedClosed.

Can you tell us about your documentation language preferences? Take a short survey.
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Case category security by role

Case processes

This article describes the considerations and decisions that you must make during the planning process, before

you begin to configure cases.

You can use the case functionality to resolve both issues that are external to your organization and internal

issues.

Only appropriate employees in an organization should have access to cases and related information. To control

which employees have access to view, create, and update different types of cases, you can assign security roles

to case category types. You must determine which security roles should have access to the various case category

types.

Decision:Decision: Determine which security roles should have access to the following case category types. Your

organization might not use all these category types, so make decisions only for those categories that are

appropriate.

General

Sales

Purchase

Service

Project

Production

Collections

Audit

Web

Human Resources

Product change

FMLA

You should set up processes that employees must follow for the cases that are opened in your organization.

Processes help guarantee consistency for the people who are involved in cases, and also help employees resolve

cases faster and more efficiently. You can set up a process for each case category that cases are assigned to.

Although planning a separate process for each case type takes time, case resolution will go much more

smoothly if the processes are planned out.

Decisions:Decisions: For each case process, you must make the following decisions:

What are the name and description of the process?

Is the process active, and should employees use it when they handle a case that the process is assigned to?

Who in the organization will be responsible for applying the process to a case? For example, Cost accounting

or Human resources might be responsible for some case processes. Note that multiple areas can be

responsible for completing one process.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/plan-case-management.md


Case categories

NOTENOTE

The Case category hierarchy provides a list of categories that you can assign cases to (see the "Case category

security by role" section). Each top-level category includes subcategories, so that you can create more specific

categories for the cases that your organization works with. Review the list of existing categories and

subcategories to determine whether you must create more. If you must create more categories and

subcategories, you must make the following decisions for each addition.

Decisions:Decisions:

Are you creating a new top-level category?

What is the name of the category

Are you creating a new subcategory?

What is the parent category of the subcategory?

What is the name of the subcategory?

Which worker will own the subcategory?

What department is the subcategory assigned to?

What case process will be assigned to this subcategory?

What is the default service level agreement (SLA) that is assigned to this subcategory?

Should an activity be created when a case that this subcategory is assigned to is opened?

If so, what are the activity category, type, purpose, and phase?

Should a follow-up activity for the case be created?

If so, what are the follow-up activity category, type, purpose, and phase?
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This article introduces the concept of record templates and explains how they can be used to create records that

share information.

Record templates can help you to create records more quickly, however you can only create record templates for

some record types.

For example, imagine you are entering rental information for a car rental business that is located in San

Francisco. Since most of the customers are likely to be from the San Francisco area, it would be nice if you could

automatically fill in the values for the StateState, Countr yCountr y , and CityCity  fields on the rental form.

You can apply templates only in areas that you have access to. However all template titles are visible to you when you

create a new record, and to other users as well, if you are creating templates that will be available for all users. Be sure to

consider this when naming templates. For example, avoid using names that include words, such as "commission," if is

confidential that some employees in the company have commission-based salaries.

When one or more templates that you have access to exist for a specific form and you attempt to create a new

record in the form, the Select a template forSelect a template for  page is displayed. When you select a template from the list, the

new record is created and contains default information that is based on the template that you selected. If you do

not want to use templates when you create new records, select the Do not ask againDo not ask again check box in the Select aSelect a

template fortemplate for  page. To display the template selection dialog box again, right-click any record, click Record infoRecord info,

and then click Show template selectionShow template selection.
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This topic demonstrates how to create a record template so that field values that are used often do not have to

be entered explicitly for each new record. In this procedure, you'll create a new record for new laptops that

should be added to your fixed assets. This procedure uses the USMF sample company.

1. In the navigation pane, go to Modules > Fixed assets > Fixed assets > Fixed assetsModules > Fixed assets > Fixed assets > Fixed assets .

2. Select NewNew .

3. In the Fixed asset groupFixed asset group field, enter or select a value.

4. In the NameName field, type a value. For example, enter Corporate lead laptopCorporate lead laptop.

5. In the Search nameSearch name field, type a value. For example, enter laptoplaptop.

6. Expand the Technical informationTechnical information section.

7. In the MakeMake, ModelModel , and Model yearModel year  fields, type values.

8. On the Action Pane, select OptionsOptions .

9. Select Record infoRecord info.

10. Select User templateUser template.

11. In the NameName field, type a value.

12. In the Descr iptionDescr iption field, type a value.

13. Select OKOK.

14. Select CloseClose.
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The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/data-entities/tasks/create-record-template-facilitate-data-entry.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Use record template to create a new record
2/18/2021 • 2 minutes to read • Edit Online

NOTENOTE

This procedure shows how to use a previously defined record template to create a new record. To complete this

procedure, you must first complete the "Create a record template to facilitate data entry" procedure.

This procedure uses the USMF company.

1. In the Navigation paneNavigation pane, go to Fixed assets > Fixed assets > Fixed assetsFixed assets > Fixed assets > Fixed assets .

2. Click NewNew . You will be prompted to select a template. Select the one that corresponds to your business need.

3. In the list, find and select the desired record.

4. Click OKOK.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/data-entities/tasks/use-record-template-new-record.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


      

    

Configure document management
2/18/2021 • 15 minutes to read • Edit Online

Configure document types

Configure SharePoint storage

This topic explains how to configure document management (document handling) so that it stores file

attachments and notes for records. It includes information about the concepts and features that are involved in

this functionality.

To learn more about document management, watch the short Document Management video.

Document types are used to categorize the documents that you attach to records or the templates that you

create. Each document type can be stored in a unique location.

A default set of document types is provided. You can use these document types to categorize an attachment as a

file, image, note, or URL. The FileFile and ImageImage default document types are configured to use Azure storageAzure storage as

the location.

To create a new document type, follow these steps.

1. Go to the Document typesDocument types  page.

2. Click NewNew .

3. In the TypeType field, enter a short name for the new document type, such as SharePointSharePoint or HR DocsHR Docs .

4. In the NameName field, enter a longer name, such as SharePoint filesSharePoint files  or HR DocsHR Docs .

5. In the ClassClass  field, specify a class to define the behavior for the document type:

Attach fileAttach file – The user is prompted for a file.

Attach URLAttach URL  – The user can enter a URL in the NotesNotes  field, such as https://www.microsoft.com . The

OpenOpen button on the AttachmentsAttachments  page will open the URL on a browser tab.

S imple noteSimple note – The user can add a simple note in the NotesNotes  field.

6. If you specified Attach fileAttach file in the ClassClass  field, in the LocationLocation field, specify the storage mechanism to

use.

7. If you specified SharePointSharePoint in the LocationLocation field, specify the Microsoft SharePoint address in the

SharePoint AddressSharePoint Address  field. To do this, click the EditEdit button (pencil symbol) and use the FolderFolder

selectionselection dialog box.

Microsoft SharePoint Online is one of the storage locations that are supported natively. Currently, only

SharePoint Online is supported. Support for on-premises SharePoint (a local SharePoint server) may be added

in the future.

To use SharePoint storage, set the LocationLocation field for a document type to SharePointSharePoint. Then, in the SharePointSharePoint

AddressAddress  field, enter a valid SharePoint address.

To configure SharePoint storage, follow these steps.

1. Go to the Document management parametersDocument management parameters  page.

2. On the SharePointSharePoint tab, in the Default SharePoint ser verDefault SharePoint ser ver  field, review the host name that was

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/configure-document-management.md
https://www.youtube.com/watch?v=p4rl1CkiLN4&feature=youtu.be


Troubleshooting SharePoint communicationTroubleshooting SharePoint communication

Configure file types

Configure document preview

For a Microsoft Dynamics 365 Finance + Operations (on-premises) environmentFor a Microsoft Dynamics 365 Finance + Operations (on-premises) environment

automatically detected for the SharePoint site, such as contosoax7.sharepoint.com. Typically, the

SharePoint host name is in the form tenantname.sharepoint.com, and accounts on that tenant are in the

form user1@tenantname.onmicrosoft.com .

Typically, if no default SharePoint server is specified, either there is no SharePoint site for the tenant, or a

valid Microsoft 365 license isn't associated with the current user (the admin).

3. Optional: Click Test SharePoint connectionTest SharePoint connection to test the specified SharePoint host name. This verifies

that the security and license are working correctly.

4. Optional: Click Open SharePointOpen SharePoint to open the specified SharePoint host name in a browser. Note that

this does not verify security, it just opens the SharePoint path in a browser tab for easy exploration.

SharePoint communication works for the current user only if the following conditions are met:

A Microsoft 365 license is associated with the user's account.

The user is a typical user on the tenant, not an external user (for example, a user from another tenant).

There is a SharePoint site for the tenant (for example, Contoso.SharePoint.com).

The user has access to the folder that the document is stored in.

If documents stored in SharePoint don't open or don't display in preview, follow these steps to troubleshoot the

issue:

1. Verify the Admin account has an associated email account (verify or change this in the UserUser  page). If this

isn't set up, you need to add the email and provider via the OData Excel add-in. By default, the email

address isn't present in the Excel design. The user needs to edit the Excel design, add all fields, apply, and

refresh. Once complete, you can update the Admin account.

2. After the Admin account has an associated email account, sign in to Dynamics as the admin.

3. Open an attachment that is stored in SharePoint.

4. Sign in with another user account that has read access to the attachments page and the configured

SharePoint folder. Verify that they can also open and preview the attachment.

By modifying the list of file extensions that are allowed, you can control the types of files that users can attach to

records.

To specify file types, follow these steps.

1. Go to the Document management parametersDocument management parameters  page.

2. On the File typesFile types  tab, review the default file types.

3. Remove any file types that users should not be able to attach to records, and add any file types that users

should be able to attach to records.

The attachments preview uses the Web app Open Platform Interface (WOPI) that is provided by Microsoft Office

Online Server. On the Document management parametersDocument management parameters  page, on the GeneralGeneral  tab, in the Office WebOffice Web

Apps Ser verApps Ser ver  field, specify the Office Online Server instance to use for attachment previews. The default value is

https://onenote.officeapps.live.com . This value points to the cloud-based WOPI server.

The default cloud-based WOPI server in Finance + Operations can't read the attachment file to provide a



 

Document preview (WOPI) will not work in environments with an IP safe list enabledDocument preview (WOPI) will not work in environments with an IP safe list enabled

Other configuration

Accessing document management attachments

Document attachment history

Configuration of document attachment historyConfiguration of document attachment history

preview. If previews are required, you must install an on-premises Office Online Server instance and configure it

inside the environment. Set the Office Web Apps Ser verOffice Web Apps Ser ver  field to the host name of the installed Office Online

Server instance, and then click SaveSave.

If previews aren't required, set the Office Web Apps Ser verOffice Web Apps Ser ver  field to https://localhost . The preview will then

show the message "No preview available" instead of an error message.

Document preview (WOPI) will not work in environments with an IP safe list enabled, because the WOPI service

that provides the preview will not be able to connect back to the file service to retrieve the file for rendering.

Here are some other configuration options to consider, although these options are rarely used:

On the Document management parametersDocument management parameters  page, on the GeneralGeneral  tab, you can use the Use DocumentUse Document

TablesTables  option to enable the Active document tablesActive document tables  allow list. If you set this option to YesYes , you disable

attachments on all other tables. Therefore, turn on this option only when it's required.

On the Document management parametersDocument management parameters  page, on the GeneralGeneral  tab, you can use the Maximum fileMaximum file

size in megabytessize in megabytes  field to set the maximum file size for attachments. Note that the ability of users to

provide files is also constrained by the file size limit that is set for the environment in configuration files.

These configuration files can't be changed via a client page.

On the OptionsOptions  page (SettingsSettings  > User optionsUser options ), on the PreferencesPreferences  tab, you can use the EnableEnable

document handlingdocument handling option to disable document handling (document management).

Document management appears to users as the AttachAttach button at the top of most pages that contain data. When

you select the AttachAttach button (or when you use the corresponding keyboard shortcut, Ctr lCtr l+ShiftShift+AA), the

AttachmentsAttachments  page is opened in the context of the data source of the control that is currently selected on the

page. This page shows all the attachments that are related to the corresponding data source.

The AttachAttach button also shows a count of the attachments for the currently selected record. Therefore, you can

determine whether there are attachments for the current record without having to open the AttachmentsAttachments  page.

The button shows exact counts for zero through nine attachments. If there are more than nine attachments, the

button shows 9+9+ as the count. In this way, the performance impact and visual noise that exact larger counts

might cause are reduced.

In version 10.0.12, the Show related document attachmentsShow related document attachments  feature changes the document attachment

experience in two ways. First, when the feature is enabled, the AttachmentsAttachments  page doesn't show only

attachments that are related to a single data source. Instead, it shows attachments from all data sources on the

page that are related to the active record. The count of attachments on the AttachAttach button also reflects this

change. Second, users can move and copy attachments between the related data sources on the AttachmentsAttachments

page.

Starting in version 10.0.16/Platform update 40, a history mechanism has been made available for record

attachments. This allows your organization to maintain an audit of actions related to individual attachments. In

particular, you can see when an attachment was created, marked for pending deletion, restored, deleted, or

moved and who performed that action. Note that attachment history is not maintained until 10.0.16/Platform

update 40, so any actions on attachments prior to that version will not be available.

Document attachment history can be enabled (or disabled) by going to Document management parametersDocument management parameters

https://technet.microsoft.com/library/jj219455.aspx


Viewing an attachment's historyViewing an attachment's history

Attachment recovery

Configuration of attachment recoveryConfiguration of attachment recovery

Deleting attachments when attachment recovery is activeDeleting attachments when attachment recovery is active

Recovering attachmentsRecovering attachments

Scanning attachments for viruses and malicious code

> GeneralGeneral  > Histor yHistor y  > Enable document histor yEnable document histor y . The default history retention period is 180 days, but this

value can be modified as needed using the Number of days to retain histor yNumber of days to retain histor y  field.

There are two entry points for viewing the history of a record attachment:

When you are looking at the attachments for a specific record (see the Accessing document management

attachments section for more details), you can view the history for the current set of attachments on the

AttachmentsAttachments  page by selecting the Document histor yDocument histor y  button in the Action pane.

Administrators can select the Document histor yDocument histor y  button in the Histor yHistor y  section of the DocumentDocument

management parametersmanagement parameters  page. This action opens the Document histor yDocument histor y  page, which shows a list of all

attachments in the system. You can then drill into any record to see the detailed history for the selected

attachment.

In Platform update 29, an attachment recovery feature has been added that provides a recycle bin for record

attachments to be recovered within a configured period of time.

Attachment recovery can be enabled by going to Document management parametersDocument management parameters  > GeneralGeneral  >

Deferred deletionDeferred deletion > Deferred deletion enabledDeferred deletion enabled. The default for Number of days to defer deletionNumber of days to defer deletion is 30

days but can be changed as needed. If the Number of days to defer deletionNumber of days to defer deletion value is zero, this means that

the deleted attachments will be recoverable for an indefinite period.

After attachment recovery is enabled, a batch job with this name will be created, "Scans for deleted references

which have reached the end of their retention period". This batch job will use the Number of days to deferNumber of days to defer

deletiondeletion to determine how long to retain a deleted attachment based on the Deleted data and timeDeleted data and time.

When a user deletes an attachment, a notification will be added to the Message Center to provide confirmation

of the deletion and an option to undo to the action if the deletion was unintended.

Table extension support has been built-in, so that any extension or custom field values on the DocuRefDocuRef or

DocuValueDocuValue tables will be retained to enable their recovery.

When attachment recovery is enabled, attachments can be recovered in one of three ways:

1. Immediately after deletion, the user can use the undo link in the Attachment deletedAttachment deleted notification.

2. On the AttachmentsAttachments  page, a Deleted attachmentsDeleted attachments  button provides access to the list of deleted

attachments that can be recovered for a particular record. The deleted attachments can be opened for review,

permanently deleted, or restored.

3. In System administrationSystem administration > Inquir iesInquir ies , the Deleted attachmentsDeleted attachments  page provides access to the list of

deleted attachments that can be recovered for any record. The deleted attachments can be opened for review,

permanently deleted, or restored.

When you work with attachments, you might want to scan the files for viruses and malicious code. Therefore, in

version 10.0.12 and later, extension points are available so that customers can integrate with the file scanning

software of their choice when they work with attachments. A similar extension point is also available for file

upload. For more information, see File upload control.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/user-interface/file-upload-control


IMPORTANTIMPORTANT

Implementation detailsImplementation details

Out of the box, Finance and Operations apps don't scan files for viruses and malicious code, and we don't recommend

specific software for file scanning. Instead, customers are responsible for choosing their own file scanning software, and for

adding the appropriate code to the delegate handlers so that they can use the software or service of their choice to scan

files.

The DocuDocu class exposes the following two delegates. Handlers can be implemented for these delegates for

document scanning purposes:

Docu.delegateScanDocument()Docu.delegateScanDocument()  – This delegate applies the file scanning logic when a new document

attachment is uploaded, or when a user tries to preview or download an existing attachment. The

corresponding action will fail if the scanning service determines that the file is malicious.

Docu.delegateScanDeletedDocument()Docu.delegateScanDeletedDocument()  – This delegate applies the file scanning logic to documents in

the attachments recycle bin when a user tries to preview or download a file. The corresponding action will fail

if the scanning service determines that the file is malicious.

The following example of the ScanDocumentsScanDocuments  class shows boilerplate code for the two handlers. For general

information about how to implement handlers for delegates, see EventHandlerResult classes in request or

response scenarios.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-tools/event-handler-result-class


    public final class ScanDocuments
    {

        [SubscribesTo(classStr(Docu), staticDelegateStr(Docu, delegateScanDocument))]
        public static void Docu_delegateScanDocument(DocuRef _docuRef, EventHandlerRejectResult 
_validationResult)
        {
            if (!ScanDocuments::scanDocument(_docuRef))
            {
                _validationResult.reject();
            }
        }

        [SubscribesTo(classStr(Docu), staticDelegateStr(Docu, delegateScanDeletedDocument))]
        public static void Docu_delegateScanDeletedDocument(DocuDeletedRef _docuDeletedRef, 
EventHandlerRejectResult _validationResult)
        {
            if (!ScanDocuments::scanDeletedDocument(_docuDeletedRef))
            {
                _validationResult.reject();
            }
        }

        private static boolean scanDocument(DocuRef _docuRef)
        {
            /*
            Custom implementation required for connecting to a scanning service
            If document scanning process found an issue, return false; otherwise, return true;
            */
            return true;
        }

        private static boolean scanDeletedDocument(DocuDeletedRef _docuDeletedRef)
        {
            /*
            Custom implementation required for connecting to a scanning service
            If document scanning process found an issue, return false; otherwise, return true;
            */
            return true;
        }

    }

Frequently asked questions
What is the difference between document handling and document management?What is the difference between document handling and document management?

What is the difference between document management and print management?What is the difference between document management and print management?

What is the difference between document types and file types?What is the difference between document types and file types?

There is no difference between document handling and document management. Both terms refer to the same

functionality. Different terms are used in different versions of the product.

Document management lets you add notes, documents, and other files to records.

Print management lets you control print settings for selected reports. Print settings include the number of

copies, the printer destination, and the multilanguage text that can be included on the report. For more

information, see Document Reporting Services.

Document types are used to categorize the documents that you attach to records or the templates that you

create. Each document type can be stored in a unique location. The table for document types is named

DocuType.

File types include Microsoft Word documents and images. A file type is denoted by the extension of the file, such



Does document management integrate with Microsoft 365?Does document management integrate with Microsoft 365?

How does the default storage location for Document Management change in Finance + OperationsHow does the default storage location for Document Management change in Finance + Operations
environments?environments?

If I accidentally delete an attachment stored in Azure Blob storage, can it be restored?If I accidentally delete an attachment stored in Azure Blob storage, can it be restored?

Is the database information about attachments stored separately from the attachments themselves?Is the database information about attachments stored separately from the attachments themselves?

Can attachments be stored in the database?Can attachments be stored in the database?

What are the main differences between Azure Blob storage and database storage?What are the main differences between Azure Blob storage and database storage?

How much storage do we get for Azure Blob storage?How much storage do we get for Azure Blob storage?

What is the cost for additional storage?What is the cost for additional storage?

How can we learn how much storage we've already used?How can we learn how much storage we've already used?

Is there an option to export all document attachments from the system?Is there an option to export all document attachments from the system?

How can attachments be extracted from the system?How can attachments be extracted from the system?

How does the document preview work for attachments stored in SharePoint?How does the document preview work for attachments stored in SharePoint?

as .txt, .png, .doc, .xlsx, or .pdf.

Yes. SharePoint storage is supported natively and can be selected as the storage location for a document type. In

addition, any URL addressable file can be made an attachment via the URLURL  document type.

For Finance + Operations, the Azure Blob storage provider for attachments is replaced by a file folder storage

provider so that attachments are kept on-premises instead of being stored in the cloud. Therefore, the default

storage location for attachments is a file folder.

If an attachment stored in Azure Blob storage is accidentally deleted, it cannot be restored or recovered because

it has been permanently deleted and the reference to it has also been deleted.

Record attachment information is stored in the DocuRef and DocuView tables. The DocuRef table is the record

that represents the attachment. The DocuRef record points to the record being attached to and to a DocuView

record. The DocuView record points to the file that is the attachment. Files are stored outside the database,

therefore any database operations, like restoring from backup, will only affect the database information about

the attachment, not the attachment file itself.

No. By default, attachments are stored in Azure Blob storage.

Database storage is Azure SQL Database. File storage is Azure Blob storage. Azure Blob storage is simpler and

much less expensive.

That information is in the licensing guide. Currently, you get 40 gigabytes (GB) of storage.

The cost for additional storage varies, but it's similar to the standard Azure costs for storage. In other words, the

cost is about $0.05 per GB.

There will be proactive communications when you're approaching your database and file storage limits.

However, Microsoft Dynamics Lifecycle Services (LCS) provides some information, and you can log support

requests for additional information.

Although attachments can be exported, that capability isn't a standard capability, because there isn't a standard

attachment entity. Entities that provide attachments for a specific business document or record must be built.

To extract attachments, an Attachments entity must be built for a specific business document or record. There

isn't a standard attachment entity because the identity for each record type is different. To learn how to build an

Attachments entity, you can find examples in the Application explorer by searching for "Attachment" under the

AOT > Data Model > Data EntitiesAOT > Data Model > Data Entities  node.

The files are retrieved from SharePoint using the current user permissions by the WOPI service. Those files are

then rendered in HTML to provide a document preview. This means that the current user needs access to the

https://go.microsoft.com/fwlink/?LinkId=866544
https://azure.microsoft.com/pricing/details/storage/page-blobs/


NOTENOTE

files to be able to preview them or open them.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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[Administrator] Email parameters page
Configuration tabConfiguration tab

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Batch email provider Specifies which email provider will be used to send emails
that are sent by processes in a batch or non-interactive
manner. The Exchange provider will use the account
associated with the batch process.

Attachment size limit Specifies the maximum size of a single email that can be sent
via the email subsystem.

SMTP settings tabSMTP settings tab

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Outgoing mail server The host name of the desired SMTP server.

SMTP port number Typically, the port number should be set to 587 for secure
transport.

The behavior of the email subsystem is influenced by a combination of administrator configuration, user

configuration, and user choices. This topic is divided into sections for administrators and users to make it easy to

find relevant information.

Both administrators and users set the behavior of the email subsystem.

On the Email parametersEmail parameters  page, note the following settings on the ConfigurationConfiguration tab.

In Platform update 32, an Email histor yEmail histor y  page was added to allow administrators to review all sent emails,

including any errors that might have prevented an email from being sent. By default, the last 30 days of email

history is retained. This can be configured by changing the Number of days to retain email histor yNumber of days to retain email histor y  to a

non-zero amount. Zero provides the default amount and behavior.

In version 10.0.16/Platform 40, an Email throttlingEmail throttling section is visible, if your environment has enabled the

Email throttlingEmail throttling feature in Feature management. This feature allows non-interactive email providers (such as

the batch email provider) to adhere to a per-minute sending limit. This can prevent errors from the system

attempting to send more emails than the provider allows. The sending limits for Microsoft 365 email providers

are set automatically according to Exchange Online sending limits. Manual configuration is required for all other

email providers. The per-minute sending limit can be removed from a provider by resetting the per-minuteper-minute

email sending limitemail sending limit field to 0.

On the Email parametersEmail parameters  page, note the following settings on the SMTP settingsSMTP settings  tab.

For Microsoft 365 production (including
*.onmicrosoft.com accounts) use smtp.office365.com.
(You can find this setting at outlook.office.com at
SettingsSettings > MailMail > POP and IMAPPOP and IMAP.)

For Outlook/Hotmail use smtp-mail.outlook.com.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/configure-email.md
https://docs.microsoft.com/en-us/office365/servicedescriptions/exchange-online-service-description/exchange-online-limits?sending-limits#sending-limits
https://support.office.com/article/Outlook-settings-for-POP-and-IMAP-access-for-Office-365-for-business-or-Microsoft-Exchange-accounts-7fc677eb-2491-4cbc-8153-8e7113525f6c


User nameUser name and PasswordPassword Specify, as needed, to send the email via the appropriate mail
account. All users need to provide the SMTP account SendSend
AsAs and Send On Behalf OfSend On Behalf Of permissions to enable the
ability to send Simple Mail Transfer Protocol (SMTP) mail. You
can configure Send As permissions in the Microsoft 365
admin center (portal.office.com/Admin), at UsersUsers  > ActiveActive
usersusers  > UserUser  > Edit mailbox permissionsEdit mailbox permissions > SendSend
email from this mailboxemail from this mailbox. For more information, see
Enable sending email from another user's mailbox in
Microsoft 365.

Specify if SSL is required Determines whether secure transport is used. Typically, this
is YesYes , except for internal or troubleshooting scenarios.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

[Administrator] Email distributor batch process

[Administrator] User email

[User] Email provider selection section on the Options page

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Email provider ID Allows the user to select the email provider that should be
used when sending an email. Selecting an option here is the
equivalent of selecting Do not ask againDo not ask again in the HowHow
would you like to send emailwould you like to send email dialog box. Selecting the
blank option Prompt for which email provider to usePrompt for which email provider to use
will cause the How would you like to send emailHow would you like to send email dialog
box to display when an email is going to be sent.

Email that is sent directly from the server, without user interaction, via SMTP is sent by the Email distr ibutorEmail distr ibutor

batchbatch process. That batch process must be started to process the email queue. To start the process, open the

Email distr ibutor batchEmail distr ibutor batch pane (System administrationSystem administration > Periodic tasksPeriodic tasks  > Email processingEmail processing > BatchBatch)

and turn on Batch processingBatch processing.

If the Exchange provider is used, then the user account associated with the batch process (usually admin) will be

sender.

The default send fromsend from address for each user is pulled from the EmailEmail  field on the UsersUsers  page (SystemSystem

administrationadministration > UsersUsers  > UsersUsers ). Administrators can override this send fromsend from default if needed using the

Sender emailSender email  field on the OptionsOptions  page.

The OptionsOptions  page can be opened via Settings > User optionsSettings > User options . The Email provider selectionEmail provider selection section is on

the AccountAccount tab.

https://support.office.com/article/Enable-sending-email-from-another-user-s-mailbox-in-Office-365-2B828C5F-41AB-4904-97B9-3B63D8129C4E


Sender email Allows the administrator to provide an email address
override for the user in the FromFrom field of the email. By
default, the email alias that is associated with the user
account is used as the FromFrom field in new emails, but this
user option email address will override that. When sending
email via SMTP, the user needs to have appropriate Send AsSend As
and Send On Behalf OfSend On Behalf Of permissions configured in
Exchange or on the SMTP server.

[!NOTE] You can configure Send AsSend As and Send OnSend On
Behalf OfBehalf Of permissions in the Microsoft 365 admin
center (portal.office.com/Admin) at UsersUsers  > ActiveActive
usersusers  > UserUser  > Edit mailbox permissionsEdit mailbox permissions > SendSend
email from this mailboxemail from this mailbox. For more information, see
Enable sending email from another user's mailbox in
Microsoft 365.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

[User] How would you like to send email dialog box (optional)

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Use an email app, such as Outlook Provides the user with a generated email (.eml) file.

Use Exchange email server Uses the Exchange Online server associated with the tenant.
On-premises Exchange servers are currently not supported
for the ExchangeExchange mail provider.

Use the system email client Opens the Send emailSend email composition dialog box and then
sends the resulting email via SMTP.

Do not ask again If this field is not selected, the next time an email is sent the
most recently selected option will be used and the dialog
box will not open.

[User] Send email dialog box (optional)

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

From Populated from the EmailEmail field on the OptionsOptions page.

ToTo, CcCc, BccBcc, SubjectSubject , and BodyBody Populated with values specified by the process that initiated
the sending of the email. These fields can be edited as
needed by the user.

Attachments list May be populated with attachments specified by the process
that initiated the sending of the email. This list can be edited
as needed by the user.

When an email is going to be sent, the user will see the How would you like to send emailHow would you like to send email  dialog box that

will list the available options for sending email.

The Send emailSend email  dialog box is opened to allow the user to edit the contents of the email that will be sent. Some

of the following fields will be pre-populated in this window.

https://support.office.com/article/Enable-sending-email-from-another-user-s-mailbox-in-Office-365-2B828C5F-41AB-4904-97B9-3B63D8129C4E


Usage scenarios to verify if email is configured correctly
Send mail via a local mail clientSend mail via a local mail client

Send mail via SMTPSend mail via SMTP

When the email is ready to be sent, the SendSend button will cause the email to be sent via SMTP.

Email workflows that are enabled via the SysEmail framework can generate email messages (.eml files) that

contain attachments. You can then send these messages via Microsoft Outlook or another email client.

1. In Internet Explorer, navigate to Accounts receivableAccounts receivable > CustomersCustomers  > All customersAll customers .

2. Select US-008 Sparrow RetailUS-008 Sparrow Retail .

3. Click CollectCollect > Customer balancesCustomer balances  > CollectionsCollections  to open the CollectionsCollections  page.

4. Click CommunicateCommunicate > EmailEmail  > Statements to contactStatements to contact.

5. Click OKOK to accept the default values in the dialog box.

6. If you're prompted for the mail option to use, clear the Do not ask againDo not ask again check box (you can change this

option from the User optionsUser options  page), select Use an email app, such as OutlookUse an email app, such as Outlook, and then click OKOK.

7. If you're using Internet Explorer on your computer, open the email (.eml) file that is generated. If you're using

Internet Explorer on the VM, copy the file to your computer, and open it there.

8. Note the email address in the ToTo field and the generated workbook attachment.

Email workflows that are enabled via the SysEmail framework can also be created in a simple email dialog box

and then sent via Simple Mail Transfer Protocol (SMTP).

1. Go to the Email parametersEmail parameters  page.

2. Click SMTP settingsSMTP settings .

3. Set the Outgoing mail ser verOutgoing mail ser ver  to the desired SMTP server :

For Microsoft 365 production (including *.onmicrosoft.com accounts) use smtp.office365.com. (Find

this setting via outlook.office.com, at SettingsSettings  > MailMail  > POP and IMAPPOP and IMAP.)

For Outlook/Hotmail use smtp-mail.outlook.com.

4. Set the user name and password to an appropriate email account and password.

5. Leave SSLRequiredSSLRequired turned on, and leave SMTP por t numberSMTP por t number  set to 587587 .

6. Click SaveSave.

7. In Internet Explorer, navigate to Accounts receivableAccounts receivable > CustomersCustomers  > All customersAll customers .

8. Select US-008 Sparrow RetailUS-008 Sparrow Retail .

9. Click CollectCollect > Customer balancesCustomer balances  > CollectionsCollections  to open the CollectionsCollections  page.

10. Click CommunicateCommunicate > EmailEmail  > Statements to contactStatements to contact.

11. Click OKOK to accept the default values in the dialog box.

12. If you're prompted for the mail option to use, select Use the Microsoft Dynamics 365 for FinanceUse the Microsoft Dynamics 365 for Finance

and Operations email clientand Operations email client, and then click OKOK.

13. To receive the test message, change the To addressTo address  to your email address.

Ensure that the account specified in the SMTP settings is able to Send AsSend As  and Send On Behalf OfSend On Behalf Of your

email account. The easiest way to ensure this to use your email account in the SMTP settings.

14. Enter a subject and body for the message.

https://support.office.com/article/Outlook-settings-for-POP-and-IMAP-access-for-Office-365-for-business-or-Microsoft-Exchange-accounts-7fc677eb-2491-4cbc-8153-8e7113525f6c


[Administrator] Workflow email notifications

Workflow email notification setupWorkflow email notification setup

15. Click SendSend. The message should be delivered in one to five minutes.

Workflow email configuration is a collection of related settings that work in conjunction.

1. Verify email settings:

a. Go to System administrationSystem administration > SetupSetup > EmailEmail  > Email parametersEmail parameters .

b. Verify that SMTP is enabled.

c. Set the SMTP mail server settings.

2. Verify that the email batch process is running:

a. Go to System administrationSystem administration > Periodic tasksPeriodic tasks  > Email processingEmail processing > Email distr ibutorEmail distr ibutor

batchbatch.

b. Enable the Batch processingBatch processing option.

c. Optionally, adjust the recurrence of the email process:

a. Select No end dateNo end date to adjust all recurrences of the email batch process.

b. Adjust the count.

c. Adjust to run every minute if needed.

3. Verify workflow notification system email templates:

a. Go to System administrationSystem administration > SetupSetup > EmailEmail  > System email templatesSystem email templates  (for system-wide

templates).

b. Verify that the Sender emailSender email  field is set and valid.

4. Verify workflow notification organization email templates:

a. Go to Organization administrationOrganization administration > SetupSetup > Organization email templatesOrganization email templates  (for organization-

specific templates).

b. Verify that the Sender emailSender email  field is set and valid.

5. Verify that the user can receive email notifications:

a. Go to SettingsSettings  > User optionsUser options .

b. Go to the AccountAccount tab.

a. Set the Email provider IDEmail provider ID (for example, SMTP).

b. Optionally, set a Sender emailSender email  override if the default send fromsend from address should not be used

for the current user.

c. Navigate to the WorkflowWorkflow  tab. Set the option to send notifications in email to YesYes .

6. Verify that the workflow system will send email notifications:

For each workflow that should have a notification, open the workflow properties in the workflow editor.

a. Click Basic settingsBasic settings . Adjust the email template for the workflow notifications.

b. Click NotificationsNotifications .

a. Enable the events for which a user should be notified.

b. Set the recipient of the workflow notification for each event notification that is enabled.

c. On a workflow approval element for which a user should be notified:



Workflow email notification testingWorkflow email notification testing

Troubleshoot email

a. Go to Proper tiesProper ties .

b. Enable the events for which a user should be notified.

c. Set the recipient of the workflow notification for each event notification that is enabled.

The testing for email notifications is to simply trigger the notification and then check for it.

1. Submit a workflow that has been set up for email notifications.

2. Check the workflow history to make sure that a workflow work item was assigned to the expected user.

3. Check the status of the pending email notification in System administrationSystem administration > Periodic tasksPeriodic tasks  >

Email processingEmail processing > Batch email sending statusBatch email sending status .

If the email is fails to send, make sure that the SMTP mail account can be opened.

4. Check for the email notification in the appropriate inbox.

There are a few standard steps that can help you troubleshoot the configuration of email settings.

1. Verify email settings:

a. Go to System administrationSystem administration > SetupSetup > EmailEmail  > Email parametersEmail parameters .

b. Verify that SMTP is enabled.

c. Verify the settings of the SMTP mail server.

d. Sign in to the SMTP account in a separate window to make sure that the account and password are

correct.

e. Send a test email using System administrationSystem administration > SetupSetup > EmailEmail  > Email parametersEmail parameters  > TestTest

emailemail .

2. Verify that the email batch process is running:

a. Go to System administrationSystem administration > Periodic tasksPeriodic tasks  > Email processingEmail processing > BatchBatch.

b. Make sure that the Batch processingBatch processing option is set to YesYes .

c. Review the recurrence of the email process:

a. Select No end dateNo end date to adjust all recurrences of the email batch process.

b. Adjust the count as you require.

3. To review the contents and status of batch emails, go to System administrationSystem administration > Periodic tasksPeriodic tasks  >

Email processingEmail processing > Batch email sending statusBatch email sending status .

a. If you're using a release that is earlier than Platform update 28, personalize the form to add the email

sender for easy review. To do this, right-click the grid header, select Add columnsAdd columns , select EmailEmail , and

then click Inser tInser t. If the EmailEmail  field isn't added into the grid, you can view the sender by selecting

Show messageShow message, and then selecting the EmailEmail  field.

b. Verify that emails are being sent from the correct account. If the account is incorrect, you need to

adjust settings such as user options, system templates, or organization templates, as needed.

c. Verify that all email user accounts have been granted permission to Send AsSend As  for the configured SMTP

account (see step 4 for details).

4. In Platform update 32, an Email histor yEmail histor y  page was added to allow administrators to review all sent

emails, including any errors that might have prevented an email from being sent. The Email histor yEmail histor y

page will show interactive as well as non-interactive/batch emails. For any emails that have an EmailEmail

statusstatus  of FailedFailed, review the error message on the Failure detailsFailure details  tab and determine if corrective



Troubleshoot the Exchange mail provider

Exchange mail provider not supported for external usersExchange mail provider not supported for external users

Other notes

Troubleshooting
Where do workflow email templates come from?Where do workflow email templates come from?

Additional resources

NOTENOTE

actions should be taken.

5. In the Microsoft 365 admin center, verify that all user mail accounts that will be used to send emails have

Send AsSend As  and Send On Behalf OfSend On Behalf Of permissions for the configured SMTP account. For more information,

see Enable sending email from another user's mailbox in Microsoft 365.

6. Sign in to all user mailboxes to verify that they are valid and can be accessed using sign in.

7. Send a test email using System administrationSystem administration > SetupSetup > EmailEmail  > Email parametersEmail parameters  > Test emailTest email .

8. If the SMTP settings were migrated from another environment, clear the password field and re-enter the

password to ensure that the field encryption hasn't negatively affected the stored value.

9. If you continue to experience issues when email is sent via SMTP, enter the SMTP account information in a

tool such as SMTPer.net to verify that the SMTP server and account are valid and working correctly.

The Email parametersEmail parameters  page allows an administrator to select Exchange as an interactive email provider and as

the Batch email provider. The Exchange mail provider will use the current user's Exchange Online account to

send emails. When used as the Batch email provider, the batch account will be used. No additional configuration

is needed. If troubleshooting is needed, ensure that the current user's account can be signed into and that emails

can be sent from that account to the intended recipients.

Users that are external to the primary tenant will not have exchange accounts on that tenant, so the Exchange

mail provider is not supported for external users.

The system communicates with Exchange or an SMTP server like a typical email client, so standard behavior and

limits apply. For example, standard Exchange Online receiving and sending limits apply.

The email templates will be sourced from either system email templates or organization email templates

depending on whether the workflow is a system-level (not company specific) or organization-level (company

specific) workflow.

Troubleshoot the Office integration

Office integration tutorial

Configure email functionality in Microsoft Dynamics AX [AX 2012]

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://support.office.com/article/Enable-sending-email-from-another-user-s-mailbox-in-Office-365-2B828C5F-41AB-4904-97B9-3B63D8129C4E
https://www.smtper.net/
https://technet.microsoft.com/library/exchange-online-limits.aspx#RecipientLimits
https://technet.microsoft.com/library/aa834374.aspx
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Date and time fields

Time zones

NOTENOTE

This article provides information about date and time fields, and time zones.

There are three types of date and time fields that correspond to different data types in the database:

Combined date/time fieldsCombined date/time fields  – These fields are the preferred method of entering date and time data. The

utcdatetimeutcdatetime data type stores time and date data in a single field in Coordinated Universal Time (UTC). UTC

is the primary time standard by which the world regulates clocks and time. It is, within about 1 second, mean

solar time at 0° longitude; it does not observe daylight saving time. Time zones around the world are

expressed using positive or negative offsets from UTC. For most purposes, UTC is considered interchangeable

with Greenwich Mean Time (GMT). The current version of UTC is defined by International

Telecommunications Union Recommendation (ITU-R TF.460-6).

Date fieldsDate fields  – These fields are used to enter dates only. The datedate data type stores a day, month, and year.

However, these values are not stored in UTC and cannot be associated with a time zone.

Time fieldsTime fields  – These fields are used to display the number of seconds that have elapsed since midnight on

the current date. The timeofDaytimeofDay  data type stores an integer value. Time values are not stored in UTC.

To express UTC times in the local time, you must provide a time zone. The time zone controls the offset from UTC

that is the equivalent of the local time. For example, the offset for Moscow is UTC+3. Your preferred time zone is

first set according to the Windows locale of your computer, although it might have been changed by an

administrator. Your preferred time zone is used only when displaying combined dates and times. To set the

preferred time zone for a user, go to UsersUsers  page. The page will show the list of users of the system. Select the

user that you want to set the preferred time zone for, and click User optionsUser options . On the Language and regionLanguage and region

tab, select the preferred time zone.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/fin-ops/organization-administration/date-time-zones.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Identifying a need for product and services

Procurement

This article gives an overview of the functionality that's available in the Procurement and sourcing module.

Procurement and sourcing covers all the steps from identifying a need for product and services through

procuring the product, receipt, invoicing, and processing of payment with vendors. Procurement processes can

be configured toward specific business needs by defining purchasing policies and workflows.

The need for products or services may arise from requisitions, for example, when an employee requires a

product. Product catalogs can be set up to guide the selection of available products to select from, or requests

can be made for products that are not yet made available in a catalog, allowing the purchasing department to

consider how the product can be supplied.

Spending limits can be used to constrain requisition spending, and the purchasing workflow adds the option of

requiring approval before ordering happen. It's also possible to specify budget fund allocation, if required.

The procurement department identifies suppliers for required products and services, and this can involve a

request for quotation being sent out to multiple potential suppliers. It's possible to share the specifications of the

product that's being requested and potential vendors can view these to see if they can deliver a product that

conforms with them. Vendors return their bids which are then reviewed by the procurement department before

they select the supplier that they want to procure from.

Purchase orders include an option to send out a purchase inquiry to the vendor as an alternative to a more

comprehensive request for quotation process. The purchase inquiry can be used to help establish terms like

prices, discounts, and delivery date for the order. If vendors are set up to use the VendorVendor  portal, purchase

inquiry functionality is disabled. Instead the order is shared on the VendorVendor  portal, and when a confirmation

request is sent the vendor can directly confirm the order.

Vendor catalogs can be used to collect information on the product assortment that vendors can supply. Vendors

can publish their own catalog, so it's easier to keep the catalog up to date. It's possible to attach an approved

vendor list to a product, and this can help guide vendor selection when new purchase orders are opened, and

prevent the use of unintended vendors.

Purchase orders can be created in a number of different ways including:

As an outcome of master planning which has identified a demand that requires a purchase. This process

generates planned purchase orders, and when these are released, purchase orders are generated.

Through the processing of purchase requisitions that result in procurement.

Through the processing of purchase agreements, where purchase orders are created as released orders from

the agreements. This is commonly used when purchase agreements are used to represent blanket orders.

Manually, when the purchase order that's created is not based on another document.

Purchase orders that are configured with purchase approval workflows require approval before they are

recorded as approved, and this is required before the order can be processed further.

Purchase orders are confirmed to represent that an agreement has been established with the vendor. The

purchase order will then gradually progress through different states until ultimately being invoiced or canceled.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/procurement-sourcing-overview.md


Prices and discountsPrices and discounts

Delivery optionsDelivery options

Supplementary itemsSupplementary items

Purchase order chargesPurchase order charges

Product receipt and invoicing

When you create a purchase order, many of the fields are pre-populated with values that default from the

information stored about the vendor in the VendorsVendors  page. This means that there are a limited number of fields

that you need to fill in on the purchase order, although you can choose to override the default values.

Prices and discounts includes information about the prices, discounts, and rebate terms that they offer. Prices

and discounts can be represented as trade agreements. Trade agreements represent vendor price lists with

prices or discounts, and have a specific set of dates for which the agreement is valid. Prices and discounts can be

negotiated and represented through purchase agreements with conditions like commitments to buy certain

volumes or monetary amounts as a precondition for the negotiated terms. Rebate agreements can be created

with vendors where the procurement of specific products or groups of products may trigger a rebate from the

vendor depending on the purchase amount or volume.

There are different options for the delivery process associated with a purchase order. Ordered products can be

split into delivery schedules, where parts of the ordered quantity can be planned for delivery on different dates.

Delivery can also include direct delivery initiated from a sales order, which automates the generation of the

packing slip on the sales order at the same time as the product receipt is recorded on the purchase order.

Purchase orders can also be part an intercompany order chain, also referred to as intercompany purchase

orders, where products are ordered from a matching intercompany sales order. In this situation, some steps are

automated across the two related intercompany orders.

Products can be set up to include supplementary items. This is to propose products that are related to the

product that's being ordered. The additional products may be required, or may be optional. In some cases,

supplementary items may be added as free products that accompany the purchase of other products.

Charges can be assigned to the purchase order. This can happen automatically through setup of automatic

charges or by adding the charges manually. Charges can be assigned to the order at the header level, or at the

order line level. Accounting of charges can be set up in different ways. For example, you can set up a charge to

be accounted as a product cost. If you do this, the charges must be assigned at the order line level before the

order can be confirmed. There is an option that can help allocate charges from the order header to the lines.

Purchase orders that include physical products commonly require arrival registration to happen within a

warehouse, and after this a product receipt is registered for the order. Purchase orders with products that fulfill

requisitions may be configured so that the employee who has requested the products also needs to provide a

confirmation of receipt.

Some purchase orders include products that are services or other non-physical products where receipt in a

warehouse is not needed. Products can be created as services or procurement categories can be used directly on

the purchase order for such orders. With these orders, accounting of product receipt is sometimes skipped and

the order is invoiced directly, or alternatively product receipt registration is done on the purchase order without

any prior arrival registration.

Receipt of products may result in automatic consumption for a specific purpose. This includes implied

consumption with direct delivery, consumption towards a project, or accounting the product as a fixed asset.

When vendor invoices arrive from the vendor they may first be recorded in the invoice register independent of

the purchase order, and then later approved as a record against the purchase order. Recording the vendor

invoice with the purchase order includes matching of the product receipt toward the invoice.

Accounting distributions can be specified on the purchase order to describe how accounting should be done



Vendor performance

NOTENOTE

within the ledger, and can also define how budget fund allocation is obtained when this is included in your

configuration.

Invoiced purchase orders will record the liability into the vendor account within accounts payable, from where

the vendor payment can be processed.

Performance and review of purchasing is supported through procurement and account payable reports, which

include spend analysis and vendor performance analysis.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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The types of workflows that you can create

T Y P ET Y P E USE T H IS T Y P E  TOUSE T H IS T Y P E  TO

Purchase requisition review Create review and approval workflows for purchase
requisitions.

Purchase requisition line review Create review and approval workflows for purchase
requisition lines.

Purchase order workflow Create review and approval workflows for purchase orders.

Purchase order line workflow Create review and approve workflows for purchase order
lines.

Vendor add application workflow Create review and approval workflows for adding new
vendors via vendor requests.

IMPORTANTIMPORTANT

Creating a workflow

Some organizations require that purchase requisitions and purchase orders are approved by a user other than

the person who entered the transaction. To set up an approval process, you can create a workflow.

A workflow represents a business process. It defines how a document flows through the system and indicates

who must complete a task or approve a document. There are several benefits of using the workflow system in

your organization:

Consistent processesConsistent processes  — You can define the approval process for specific documents, such as purchase

requisitions and expense reports. Using the workflow system helps to ensure that documents are processed

and approved in a consistent and efficient manner.

Process visibilityProcess visibility  — You can track the status, history, and performance metrics of a specific workflow

instance. This helps you determine whether changes should be made to the workflow to improve efficiency.

Centralized work listCentralized work list — Users can view a centralized work list to view the workflow tasks and approvals

assigned to them across all workflows they participate in. This is available in the Work items page.

The following workflow types are available for Procurement and sourcing.

When you are adding a new workflow, you might also see the following obsolete workflows listed in the CreateCreate

workflowworkflow dialog box. These are related to the confirmation of receipt functionality that was available in Dynamics AX

2012, but which has now been deprecated. These workflows are currently unsupported.

Delivery due date notification workflow

Invoice received notification workflow

Product receipt failed notification workflow

Unconfirmed product receipt rejection notification workflow

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/procurement-sourcing-workflows.md
https://docs.microsoft.com/en-us/dynamicsax-2012/appuser-itpro/set-up-procurement-and-sourcing-workflows


Types of participants

USER GRO UPUSER GRO UP DESC RIP T IO NDESC RIP T IO N

Participant Assign the approval step to members of a group or role.

Hierarchy Assign the approval step to users in a specific organizational
hierarchy.

Workflow user Assign the approval step to users of this workflow.

Queue Assign the approval step to a work item queue.

User Assign the approval step to specific users.

Additional resources

NOTENOTE

To create a workflow, go to Procurement and sourcing > Setup > Procurement and sourcing workflows and

create a new workflow by selecting the type of workflow you want to create.

In the workflow canvas you can drag workflow elements into the designer and link the elements into a flow. The

workflow elements should be configured. For approval and task workflow elements you can configure which

participant should take action.

You can assign an approval step to the following groups of participants.

Defining business process workflows for purchase requisitions

Purchase requisition workflow

Onboard vendors

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://www.microsoft.com/download/details.aspx?id=101821
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Error when re-submitting a purchase order to the workflow after a
change: "Changes to purchase order X are allowed only in a Draft
state when change management is activated"

Error descriptionError description

Issue resolutionIssue resolution

One or more accounting distributions are either over-distributed or
under-distributed.

If a delivery remainder is canceled on a purchase order where change
management is turned on, the purchase order goes to a Confirmed
state.
Issue descriptionIssue description

This topic describes how to fix issues that you might encounter while you work with procurement and sourcing

workflows.

This issue occurs only if the purchase order was in a Confirmed state before you requested changes. If you

request changes while the purchase order is in an Approved state, the workflow can be processed successfully.

The following error occurs in the workflow when a purchase order is resubmitted after a change:

Stopped (error): X++ Exception: Changes to purchase order PO0000569 are only allowed in state Draft

when change management is activated at

SysWorkflowParticipantProvider-resolve

SysWorkflowParticipantProvider-resolveParticipants

SysWorkflowServiceProvider-resolveParticipant

SysWorkflowQueue-resume

This issue can occur because of inconsistency in purchase order distributions.

To unblock this issue and reset the purchase order to a Draft state, go to Procurement and sourcing >Procurement and sourcing >

Periodic tasks > Clean up > Purchase order distr ibution resetPeriodic tasks > Clean up > Purchase order distr ibution reset. For more information, see the following

blog post: Resolve PO distribution errors in Dynamics 365 Supply Chain Management.

The issue will be fixed through this Microsoft Knowledge Base (KB) article.

This issue can occur because of inconsistency in purchase order distributions.

To unblock this issue and reset the purchase order to a Draft state, go to Procurement and sourcing >Procurement and sourcing >

Periodic tasks > Clean up > Purchase order distr ibution resetPeriodic tasks > Clean up > Purchase order distr ibution reset. For more information, see the following

blog post: Resolve PO distribution errors in Dynamics 365 Supply Chain Management.

For a purchase order that is subject to change management, if the only change that is requested is the

cancellation of a delivery remainder on one or more of the lines, the purchase order will go directly to a

Confirmed state when it's approved, and no journal will be created.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/troubleshoot-procurementworkflows.md
https://cloudblogs.microsoft.com/dynamics365/it/2020/08/12/resolve-po-distribution-errors-in-dynamics-365-supply-chain-management/
https://msdyneng.visualstudio.com/FinOps/_workitems/edit/467138
https://cloudblogs.microsoft.com/dynamics365/it/2020/08/12/resolve-po-distribution-errors-in-dynamics-365-supply-chain-management/


Issue resolutionIssue resolution

Canceled purchase orders appear in the draft list in the Purchase
order preparation workspace.
Issue descriptionIssue description

Issue resolutionIssue resolution

NOTENOTE

Cancellation of a delivery remainder doesn't affect the contents of the confirmation journal. This functionality

should be used when the line has been partially received, and the remainder quality should be canceled in the

process step after the purchase order has been confirmed with the vendor.

If this should be reflected on the purchase order confirmation, the quantity should be adjusted on the purchase

order line so that the confirmation will be required. Alternatively, if nothing has been received on the line, the

quantity can be removed. In this case, reconfirmation will be required.

After you cancel purchase orders that were in a Confirmed state, the canceled purchase orders still appear in the

list of draft purchase orders in the Purchase order preparationPurchase order preparation workspace.

This issue occurs only for purchase orders that are subject to change management. It occurs because the

cancellation is considered a change that must be approved. The approval can be done automatically by the

system. Therefore, the process is to submit the canceled purchase order to the approval workflow so that it can

go to an Approved state. At that point, the purchase order will no longer appear in the list of draft purchase

orders in the Purchase order preparationPurchase order preparation workspace.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Prerequisites

TA SKTA SK RO L ERO L E DESC RIP T IO NDESC RIP T IO N

This article describes, at a high level, how purchasing professionals can set up and maintain procurement

catalogs. Procurement catalogs define the items and services that company employees can order for internal

use.

Purchasing professionals can create and maintain catalogs of the items and services that can be purchased for

internal use in an organization. After catalogs are set up, company employees can create purchase requisitions

to order from them. The catalogs can be used to enforce purchasing policies, so that employees can order only

the items and services that are allowed for their buying legal entity. When you create a procurement catalog,

you should consider the following tasks:

Configure your procurement category hierarchy before you create the catalog.

Determine which products you want your employees to be able to order. You can show or hide specific

products in a catalog node, or you can show or hide all the products in a node.

Determine how many procurement catalogs you require. Access to a procurement catalog is determined by

the catalog policy rule that you configure for the legal entity and operating unit that an employee is assigned

to.

Several factors determine the products that employees can order and the procurement categories that they can

use when they create purchase requisitions:

The category access policy rule in the purchasing policy determines which procurement categories are

available in the purchase requisition. If no rule is defined, all procurement categories are available.

Employees can order a product only if it's in the active procurement catalog for your organization, and if it's

in an enabled node and not hidden. The product must also be in a category that a particular employee has

access to according to the category access policy rule.

The catalog policy rule specifies the catalog that is used. If no catalog policy rule is defined, the category

access rule alone determines the products that an employee can order on the requisition.

The following table describes the tasks that must be completed before a purchasing professional can create a

procurement catalog.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/procurement-catalogs.md


Set up a procurement category
hierarchy.

Purchasing manager Procurement category hierarchies
classify items or transactions for
reporting and analysis. By using a
procurement category hierarchy,
companies can strategically manage
categories, products, vendors, and
other procurement factors from a
central location. One procurement
category hierarchy is defined for a
whole organization. The catalog is
based on the procurement category
hierarchy: the categories in the
hierarchy become nodes in the catalog.
The vendors and products are included
in your catalog.

Add vendors and products to
procurement categories.

Purchasing manager When the procurement category
hierarchy is created for your
organization, each procurement
category can be associated with
specific vendors, products, and so on.
These associations are copied
automatically to the catalog.
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Setting up a catalog
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Create a new catalog. Purchasing agent When you create a catalog, you specify
a name and description for the catalog.
You also define whether the catalog is
updated manually or automatically,
and specify the catalog owner.

Control whether products are available
in the catalog.

Purchasing agent Because the products are inherited
from the procurement categories, they
all appear in the appropriate catalog
nodes. You can control whether all
products in a node are hidden or
shown when the catalog is used in a
purchase requisition. You can also
control whether individual products in
a node are hidden or shown.

After the prerequisites have been met, you can set up catalogs. You can create either one catalog that your whole

organization uses or multiple catalogs that the various divisions in your organization use. If you create one

catalog for the whole organization, access to the catalog is controlled by your purchasing policy rules.

The catalog defines which products are available when purchase requisitions are created, but you can use

category access policies rules to apply additional restrictions. Because the nodes in a catalog are procurement

categories, they can be suppressed by a category access policy rule. In this case, the products in that category

are not available for employees to use on requisitions. You define category access policy rules on the

Purchasing policiesPurchasing policies  page. The following table describes the tasks that must be completed to set up a catalog.



Publish the catalog. Purchasing agent Before a catalog is available for
employees to use in a requisition, you
must define a catalog policy rule for
the catalog, set the catalog’s status to
ActiveActive, and publish the catalog. You
can inactivate catalogs that you no
longer want to be available to your
users.

TA SKTA SK RO L ERO L E DESC RIP T IO NDESC RIP T IO N

Additional resources

NOTENOTE

Updates are published either automatically or manually, depending on the option that you select for the catalog

in the Default update typeDefault update type field on the CatalogsCatalogs  page. The following default update types are available for

catalogs:

DynamicDynamic – The catalog is automatically updated whenever it's changed.

StaticStatic – The catalogs must be manually updated.

BothBoth – If the catalog includes product categories that have a default update type of StaticStatic, it must be

manually updated when these categories are updated. If the catalog includes product categories that have a

default update type of DynamicDynamic, it is automatically updated whenever it's changed.

Set up a procurement category hierarchy

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Ensure that a procurement category hierarchy exists

Create a catalog

Make the catalog visible

This topic explains how to create a procurement catalog. This task would typically be carried out by a

procurement professional. You will also learn how employees can use the catalog when they create a requisition.

Before you can create a catalog, there must be a procurement category hierarchy in your system. The hierarchy

is inherited by the new catalog, along with all the products that are in the hierarchy. You can use this guide in

demo data company USMF where the procurement category hierarchy is available, as well as the examples used

in the procedure steps.

1. Go to navigation pane > Modules > Procurement and sourcing > Procurement categoriesnavigation pane > Modules > Procurement and sourcing > Procurement categories . A

procurement category hierarchy is available in the USMF demo data company and products have been

added to the Office machines/ComputersOffice machines/Computers  category. If you're running this procedure as a task guide, you'll

need to unlock the guide if you want to browse through the category. If a hierarchy was not available, you'd

create it by clicking NewNew . This can only be done once.

2. Close the page.

1. Go to navigation pane > Modules > Procurement and sourcing > Catalogs > Procurementnavigation pane > Modules > Procurement and sourcing > Catalogs > Procurement

catalogscatalogs .

2. Select New procurement catalogNew procurement catalog to open the drop dialog.

3. In the NameName field, type a value.

4. Select OKOK.

5. In the tree, expand CORP PROCUREMENT CATEGORIESCORP PROCUREMENT CATEGORIES .

6. In the tree, expand OFFICE MACHINESOFFICE MACHINES .

7. In the tree, select ComputersComputers .

The products from the procurement category are displayed in the list. If you want to add a product to the

category you need to do this on the Procurement categor y hierarchyProcurement categor y hierarchy  page or on the Item detailsItem details  page.

The DefaultDefault update type determines whether new products that have been added to the procurement

category hierarchy are immediately visible in the catalog. If the update type is set to DynamicDynamic, changes are

visible immediately. If the update type is StaticStatic, new products are only visible to people using the catalog

after the catalog has been re-published. The PublishPublish action is available on the Action Pane at the top of the

page. If products are removed from the procurement category hierarchy, the change is immediately visible,

regardless of the value in the DefaultDefault update type field.

8. On the Action Pane, select Categor y navigationCategor y navigation and ensure that EnableEnable is selected.

9. Select Activate catalogActivate catalog.

10. Close the page.

1. Go to navigation pane > Modules > Procurement and sourcing > Setup > Policies > Purchasingnavigation pane > Modules > Procurement and sourcing > Setup > Policies > Purchasing

policiespolicies .

2. Select Procurement Policy USMFProcurement Policy USMF. You need to select the purchasing policy for the legal entity that the

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/tasks/create-procurement-catalog.md


Use the catalog
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worker connected to your user profile is allowed to order products in. In the USMF demo data, the Admin

user is connected to the worker called Julia FunderburkJulia Funderburk , and she orders products in USMF by default.

3. Select the catalog that you've just created.

4. Select OKOK.

1. Go to navigation pane > Modules > Procurement and sourcing > Purchase requisitions > Allnavigation pane > Modules > Procurement and sourcing > Purchase requisitions > All

purchase requisitionspurchase requisitions .

2. Select NewNew .

3. In the NameName field, type a value.

4. Select OKOK.

5. Select Add productsAdd products .

6. In the list, find and select the desired record. You can use the category hierarchy on the left or the filter at the

top of the list to filter the products.

7. Select Add to linesAdd to lines .

8. Select OKOK.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Add a new procurement category

Add products to your new procurement category
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This procedure shows you how to create new nodes in a procurement category hierarchy and how to configure

a procurement category to be used in a procurement process. These tasks would typically be carried out by a

Purchasing manager. Before you can start this procedure, there must be a category hierarchy of type

Procurement. If you're using a demo data company, you can run this procedure in the USMF company.

1. Go to Navigation pane > Modules > Procurement and sourcing > Consignment > ProcurementNavigation pane > Modules > Procurement and sourcing > Consignment > Procurement

categoriescategories .

2. On the Action Pane, select Edit categor y hierarchyEdit categor y hierarchy . The current procurement category hierarchy is

displayed in the left side of the page. You are about to modify the hierarchy.

3. On the Action Pane, select New categor y nodeNew categor y node. The system selects the top node by default. If you are

running this procedure as a task guide, you can click the Unlock button and select another parent node to

insert your new node into. Once that is done, lock the task guide again and then click New category node.

4. In the NameName field, type a value.

5. In the Descr iptionDescr iption field, type a value.

6. In the Fr iendly nameFriendly name field, type a value. The friendly name is optional. It will be displayed in category

lookups together with the category name.

7. Select SaveSave.

1. Go to Procurement and sourcing > Consignment > Procurement categoriesProcurement and sourcing > Consignment > Procurement categories . Select the node you

just added. If you're running this procedure as a task guide you might need to unlock the task guide to select

the node.

2. Toggle the expansion of the ProductsProducts  section.

3. Select AddAdd to associate products with the procurement category.

4. Select the products you want to add to the procurement category.

5. Select the arrow to add the products to the SelectedSelected table.

6. Select OKOK.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Creating purchase requisitions

Purchase requisition statusesPurchase requisition statuses

Purchase requisition workflowPurchase requisition workflow

This topic describes the purchase requisition workflow and the different statuses that a purchase requisition can

have.

Depending on the setup of your organization, you can create purchase requisitions for products that your

organization uses. A purchase requisition is an internal document that authorizes the Purchasing department to

buy items or services.

After a purchase requisition is approved, it can be used to generate a purchase order. Purchase orders are the

external documents that the Purchasing department submits to vendors.

You can create a purchase requisition on the My purchase requisitionsMy purchase requisitions  page, and select the items and

services that you require. You can select items from a procurement catalog that your organization has created,

or you can request items that aren't found in a catalog by selecting a procurement category and entering the

product details.

Before you can submit a purchase requisition for review, workflows must be configured. You use a workflow to

move a purchase requisition through the review process, from an initial status of DraftDraft to a final status of

ApprovedApproved.

When you create a purchase requisition, a status is assigned to it. A status is also assigned to every line that you

add to a purchase requisition. When you submit a purchase requisition to a workflow for review, the status of

the purchase requisition and the status of each line are updated as the lines move through the workflow

process.

You can configure the purchase requisition workflow process to route a purchase requisition through the review

process as a single document. Alternatively, the lines on a purchase requisition can be routed individually to the

appropriate reviewers. If the purchase requisition lines are reviewed individually, the status of each purchase

requisition line can be updated as the line moves through the review process. When all lines have completed the

review process and no review steps remain for the purchase requisition, the status of the whole purchase

requisition is updated.

The following diagram shows the statuses that are assigned to a purchase requisition and a purchase requisition

line as they move through the workflow process.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/purchase-requisitions-overview.md
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Draft Draft The purchase requisition and purchase
requisition line have been created, but
they haven't been submitted for
review. Purchase requisitions and
purchase requisition lines that have a
status of DraftDraft  can be modified. A
purchase requisition or purchase
requisition line also has a status of
DraftDraft  if it has been recalled but hasn't
been resubmitted for review. Note:Note:
You can submit or recall a purchase
requisition at the document level.
However, you can't submit or recall a
single purchase requisition line.

The overall status of a purchase requisition is determined by the status of the purchase requisition lines.

Therefore, the review process must be completed for all purchase requisition lines before the review process for

the whole purchase requisition can be completed. The following table describes the statuses that are assigned to

a purchase requisition header and lines as the purchase requisition moves through the workflow process.

file:///T:/eiye/ac1a/dynamics365/supply-chain/procurement/media/purchasereq_headerline_statuses.jpg


In review If the workflow has been configured to
route purchase requisition lines to
individual reviewers, each line can have
a status of In reviewIn review or RejectedRejected.
The purchase requisition status is
updated when the review process is
completed for all purchase requisition
lines and no review steps remain for
the purchase requisition.

If you resubmit a purchase requisition
line that has been rejected, the review
process starts over for all lines in the
purchase requisition that are still in
review. 
Note:Note:  You can recall a purchase
requisition that has already been
submitted. When you recall a purchase
requisition, all other purchase
requisition lines are also recalled.
Purchase requisition lines that have
been recalled can be deleted.

Rejected Rejected The purchase requisition and all
purchase requisition lines have been
rejected. Purchase requisitions and
purchase requisition lines that have
been rejected can be resubmitted.
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In review

Rejected

In reviewIn review – The purchase
requisition lines have been
submitted for review. When the
workflow process is completed
for a purchase requisition line,
the status of that line remains
In reviewIn review until all remaining
purchase requisition lines have
been reviewed.

RejectedRejected – A purchase
requisition line has been
rejected. Purchase requisition
lines that are rejected can be
modified and resubmitted.



Approved All purchase requisition lines have
completed the review process, and
there are no more review steps for the
purchase requisition.

Cancelled Cancelled The purchase requisition and all
purchase requisition lines have been
canceled.
Note:Note:  If you no longer require an item
that is on a purchase requisition line,
you must cancel the purchase
requisition line if it has already been
approved. Only purchase requisition
lines that have been approved can be
canceled. If any purchase requisition
lines are in review, the purchase
requisition will have a status of InIn
reviewreview. In this case, you can recall the
purchase requisition and delete the
appropriate purchase requisition line.
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Approved

Cancelled

Closed

ApprovedApproved – The review
process for a purchase
requisition line has been
completed, and the line is
approved.

CancelledCancelled – The purchase
requisition line was approved,
but it has been canceled
because it's no longer required.
Only purchase requisition lines
that have been approved can
be canceled.

ClosedClosed – The purchase
requisition line was approved,
and documents have been
generated, depending on the
requisition purpose.

If the requisition
purpose is
consumption, a
purchase order has
been generated for the
purchase requisition
line.

If the requisition
purpose is
replenishment, one or
more fulfillment
documents have been
generated.



Closed The purchase requisition is closed, and
one or more fulfillment documents
have been generated.

Note:Note:  If you no longer require an item
on a purchase requisition line that has
been closed, you must cancel the line
on the fulfillment document that was
generated for the purchase requisition
line.
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Distributing costs to multiple financial accounts

Requisition purposes

Requisitions that have a purpose of consumptionRequisitions that have a purpose of consumption

Closed

Cancelled

ClosedClosed – The purchase
requisition line was approved,
and documents have been
generated, depending on the
requisition purpose.

CancelledCancelled – The purchase
requisition line was approved,
but it has been canceled
because it's no longer required.
Only purchase requisition lines
that have been approved can
be canceled.

If the requisition
purpose is
consumption, a
purchase order has
been generated for the
purchase requisition
line.

If the requisition
purpose is
replenishment, one or
more fulfillment
documents have been
generated.

You can distribute the cost of a product that is included in a purchase requisition to multiple financial accounts. If

your organization uses dimensions, such as cost centers and departments, you can distribute the cost of a

product to dimensions for financial accounts.

Requisition purposes make the process of fulfilling requisition demand more flexible. When you create a

requisition, you can assign one of two purposes to it: consumption or replenishment. Depending on the

requisition purpose and the setup of your organization, requisition demand can be fulfilled by a purchase order,

transfer order, production order, or kanban.

In the procurement policies, you can control the requisition purposes that are available when a requisition is

created for your organization.

A requisition that has a purpose of consumption represents demand for items or services that will be used

internally by your organization. The demand that is created by this kind of requisition is always fulfilled by a

purchase order. If Supply Chain Management is set up to automatically generate purchase orders, purchase

orders are created after the purchase requisition is approved.



Requisitions that have a purpose of replenishmentRequisitions that have a purpose of replenishment

Purchase requisitions and requests for quotation

NOTENOTE

Demand consolidation

A requisition that has a purpose of replenishment represents demand to replenish inventory. For example, you

create a requisition to replenish items so that they can be sold at a specific retail location at a specific time. The

demand that is created by this kind of requisition can be fulfilled by a purchase order, transfer order, production

order, or kanban.

When the requisition purpose is replenishment, demand is expressed as a quantity instead of a monetary

amount. Therefore, encumbrance accounting, budgetary control, business rules for fixed asset determination

(BRAD), project accounting, and any related rules don't apply. Only products that are stocked and released to the

specified legal entity can fulfill replenishment requisition demand. To define the products that are available when

the requisition purpose is replenishment, use the Replenishment categor y access policy ruleReplenishment categor y access policy rule page.

To use purchase requisitions that have a purpose of replenishment, you must set up master scheduling to

include requisition demand. The fulfillment method for the demand that is created by this kind of requisition is

then determined automatically, based on the supply policies that have been set up for the items in your

organization and planned by using master scheduling.

In some cases, you must start a request for quotation (RFQ) process to identify the vendor and price for

products that are requested in a purchase requisition. An RFQ can be generated when the purchase requisition

is in review. When you accept a bid, information about the vendor, price, and so on, is transferred to the

requisition.

You can put a purchase requisition on hold by selecting the On holdOn hold check box on the Purchase requisitionPurchase requisition

detailsdetails  page. Processing of the purchase requisition can continue only after you remove the hold by clearing

the check box.

In e-procurement, the RFQ for your purchase requisition might allow vendors to add alternate lines. In this case, your

purchase requisition will reflect approved alternates.

By consolidating purchase requisition lines from multiple purchase requisitions, you can increase your

negotiating power with your vendors to achieve better pricing, lower shipping and handling costs, and reduced

overhead costs.

Purchase requisition lines are eligible for demand consolidation only if the following statements are true:

The purchase requisition has been approved.

The purchase requisition meets the purchasing policy rule criteria for manual processing and demand

consolidation.

Approved purchase requisition lines that meet the criteria for manual processing are listed on the ReleaseRelease

approved purchase requisitionsapproved purchase requisitions  page. If a purchase requisition line also meets the criteria for demand

consolidation, the line can be added to a consolidation opportunity.

A consolidation opportunity is a set of purchase requisition lines that are grouped together, so that the

purchasing professional can negotiate the best deal with vendors. Purchase requisition lines that you select for a

consolidation opportunity appear on the Purchase requisition consolidationPurchase requisition consolidation page. You can modify the lines

on this page, if changes are required. You can also add new lines to the consolidation opportunity or remove

existing lines.
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Consolidating purchase requisition linesConsolidating purchase requisition lines

Additional resources

NOTENOTE

After you add requisition lines to a consolidation opportunity and make any changes that you require, you can

create a purchase order for the consolidated purchase requisition lines.

Changes that you make to a purchase requisition line on the Purchase requisition consolidationPurchase requisition consolidation page are reflected

on the purchase order that you create. However, the line remains unchanged in the purchase requisition, so that its

history is preserved.

To create a purchase order for purchase requisition lines that aren't eligible for demand consolidation or aren't

selected for a consolidation opportunity, you must process the lines manually.

The process for demand consolidation starts when a purchase requisition is approved in a workflow and, if

budget control is configured for your organization, when the budget reservations and pre-encumbrances have

been recorded. The following diagram shows the process flow for demand consolidation.

To consolidate approved purchase requisition lines, follow these steps:

1. Review approved requisition lines that have been held for manual processing, and that are eligible for

demand consolidation.

2. Select lines to add to a consolidation opportunity.

3. Create a new consolidation opportunity, or add requisition lines to an existing consolidation opportunity.

4. Make any required changes to the requisition lines, and remove requisition line items that you no longer

want to include in the consolidation opportunity.

5. Create purchase orders for consolidated requisition lines or for purchase requisition lines in a consolidation

opportunity.

Create a requisition for consumption

Purchase requisition workflow

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Example 1: Route a purchase requisition as a single document for
review

The workflow process moves purchase requisitions through the review process, from an initial status of Draft to

a final status of Approved. When a purchase requisition is submitted for review, the workflow process is started.

After a purchase requisition is approved, a purchase order can be generated for the purchase requisition lines

and submitted to the vendor for order fulfillment.

Before a purchase requisition can be submitted for review, you must configure a workflow. The workflow

process can include one or more review steps, in any order. The workflow process can also be configured to skip

the review tasks and automatically approve the purchase requisition. You can configure the workflow to route

the purchase requisition as a single document, or you can route individual purchase requisition lines to the

appropriate reviewers. You can also create a scenario where the purchase requisition is routed as a single

document to some reviewers and selected purchase requisition lines are routed to other reviewers.

If purchase requisition lines are reviewed individually, the review process must be completed for all purchase

requisition lines before the workflow process can move to the next step, and before the review process for the

purchase requisition as a whole can be completed. When the review process has been completed for the

purchase requisition and all its lines, the overall status of the purchase requisition is updated to ApprovedApproved.

You can configure your workflow to represent the business process for purchase requisitions in your

organization. When you configure your purchase requisition workflow process, consider the following

questions:

What expenditures must be reviewed?

What expenditures can be automatically approved?

Who is required to review and approve expenditure requests? What role are these users assigned to?

What process must be followed if a reviewer is not available?

The following examples illustrate two ways that you can configure a workflow for purchase requisitions.

The following illustration shows how a purchase requisition can flow through the workflow review process as a

single document. The lines on the purchase requisition aren't routed individually. The following roles are

included in the workflow process for this example:

RequesterRequester  – The user who requests the items or services. The requester can prepare the purchase

requisition, or another worker can prepare the purchase requisition on the requester ’s behalf. This worker is

the preparer. The preparer is responsible for managing the purchase requisition throughout the review

process. Only the preparer of the purchase requisition can modify it.

Note:Note: A worker must be granted the appropriate permissions to create a purchase requisition on behalf of

someone else. Use the Purchase requisition permissionPurchase requisition permission page to set up these permissions.

Purchasing agentPurchasing agent – The user who performs a procurement review and can approve the document.

The requester 's managerThe requester 's manager  – The user who performs a managerial review and can approve the document.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/purchase-requisitions-workflow.md


Example 2: Route the individual purchase requisition lines for review

In this example, the workflow process for the purchase requisition includes the following steps:

1. The preparer submits a purchase requisition for review.

2. The purchasing agent receives a notification. The notification requests that the purchasing agent verify the

information in the purchase requisition. If required information is missing, the purchasing agent can either

add it or return the purchase requisition to the preparer to add it. When all the required information has

been filled in, the purchase requisition can move to the next step in the review process.

3. The requester's manager reviews the purchase requisition. The purchase requisition might be routed to the

requester's manager if, for example, the amount of the purchase requisition exceeds the requester ’s spending

limit for purchase requisitions. The requester's manager can approve or reject the purchase requisition, or

return it to the preparer for changes.

The following illustration shows how the individual purchase requisition lines can be routed through a workflow.

In general, the process for each line is the same as the process for a purchase requisition that is reviewed as a

single document. However, each line must complete the workflow process individually before the workflow can

be completed for the whole purchase requisition.

In this example, a worker enters a request for posters and T-shirts for a marketing campaign. The cost of the

posters is split between the Marketing department and the Sales department. If the cost of the posters or T-

shirts exceeds the signing limit authority for department managers, the purchase requisition must also be

reviewed by the group manager.

The following roles are included in the workflow process for this example:

RequesterRequester  – The user who requests the items or services. The requester can prepare the purchase

requisition, or another worker can prepare the purchase requisition on the requester ’s behalf. This worker is

the preparer. The preparer is responsible for managing the purchase requisition throughout the review

process. Only the preparer of the purchase requisition can modify it.

Note:Note: A worker must be granted the appropriate permissions to create a purchase requisition on behalf of

someone else. Use the Purchase requisition permissionPurchase requisition permission page to set up these permissions.

Purchasing agentPurchasing agent – The user who performs a procurement review and can approve the document.

The requester 's managerThe requester 's manager  – The user who performs a managerial review and can approve the document.

Depar tment managerDepar tment manager  – The user who performs an expenditure review and can approve the document.

Group managerGroup manager  – The user who performs a signature authority review and can approve the document.
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Configuring a workflow for purchase requisitions

In this example, the workflow process for the purchase requisition lines includes the following steps:

1. The preparer submits a purchase requisition for review. Each line is routed to the reviewer who is configured

to receive it in the workflow process.

2. The purchasing agent receives a notification. The notification requests that the purchasing agent verify the

information in the purchase requisition and on the purchase requisition lines. When the purchase requisition

is opened by the purchasing agent all the lines are visible, but a visual indicator shows which lines have been

sent to the purchasing agent for review. If required information is missing, the purchasing agent can either

add it or return a purchase requisition line to the preparer to add it. When all the required information has

been filled in, the purchase requisition line can move to the next step in the review process. Purchase

requisition lines can continue through the review process independently of each other.

3. The requester's line manager reviews and approves the purchase requisition lines. The approval might be

routed to the requester's manager if, for example, the amount on a purchase requisition line exceeds the

requester ’s spending limit for purchase requisition lines. The manager can approve or reject one or both of

the purchase requisition lines.

4. The department manager for the Marketing department reviews the purchase requisition lines for both the

posters and the T-shirts. The Sales department manager reviews the purchase requisition line only for the

posters, because that is the only cost that is being charged to the Sales department.

5. The group manager reviews and approves the purchase requisition line for the T-shirts only if group

manager approval is required because, for example, the amount on the purchase requisition line exceeds the

department manager’s approval limit. The group manager does not have to approve the purchase

requisition line for the posters.

The system currency must be set if the header workflow for a purchase requisition requires approvals related to signing

limits.

To route a purchase requisition for review, you must configure the purchase requisition workflow processes. The

workflow process that you define controls the interaction between the user who requested the items (the

requester) and the reviewer and approver in the workflow. The routing of the purchase requisition depends on

the conditions that are specified in the workflow configuration. For example, these conditions determine when

the purchase requisition should be routed, the user or role that it should be routed to, and the actions that users

can take.

The examples in this topic show how a purchase requisition can be routed through a workflow as a single

document or as individual purchase requisition lines. You can also configure a workflow for purchase

requisitions that reflects the internal control review of purchase requisitions that is defined for your

organization.

The participants or the reviewers that a task is assigned to in a workflow can be members of a particular user



Purchase requisition expenditure reviewersPurchase requisition expenditure reviewers

Additional resources
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group, users who have a particular security role, users who are associated with the submitter in a managerial

hierarchy, or named users or users who have specific expenditure responsibilities.

Expenditure reviewer configurations let you dynamically route expenditures for review, based on the user who is

assigned to a project role or a financial dimension where the expenditure is being charged. The workflow

process uses the specified project role or financial dimension owner to determine who the expenditure should

be routed to.

You can define one or more expenditure reviewer configurations and then select a configuration when you

create a workflow. You can configure the expenditure reviewer values for every legal entity in your organization.

After you define the expenditure reviewer configurations, you assign a configuration to your workflow task.

You don't have to define expenditure reviewer configurations. Instead, you can assign specific users or user

groups as reviewers when you define your workflow. However, if you have a complex organization, expenditure

reviewers can increase the efficiency of your approval process. In addition, if you set up expenditure reviewers,

you don't have to update workflow reviewer assignments every time that a reviewer changes job roles.

You can set up the expenditure reviewers on the Purchase requisition expenditure reviewersPurchase requisition expenditure reviewers  page. Create

an expenditure reviewer configuration, and enter values for each legal entity in your organization. For

requisitions that are assigned to a project, you can specify the role that is responsible for reviewing the

requisitions: Project manager, Project controller, or Project sales manager. Expenditures will be routed to the user

who is assigned to the specified role. You can also route the expenditure to the financial dimension owner by

selecting the appropriate financial dimension option on the Organization distr ibutionsOrganization distr ibutions  tab.

To use one of the expenditure reviewers that you set up in a workflow, you must set the Type of par ticipantType of par ticipant

option to Expenditure par ticipantsExpenditure par ticipants  in the AssignmentAssignment properties for the relevant workflow element.
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This topic provides an overview of requests for quotation (RFQs). Organizations issue RFQs when they want to

receive competitive offers from several vendors for the items or services that they must purchase. In an RFQ,

you ask vendors to provide the prices and delivery times for the item quantities that you specify. You can also

ask vendors to specify whether there are any incidental charges, such as shipping costs, or any discounts for

large orders or early payment of the vendor invoice.

The RFQ process consists of the following tasks:

1. Create and send an RFQ to one or more vendors.

2. Receive and register bids (RFQ replies).

3. Transfer bids that you accept to a purchase order, purchase agreement, or purchase requisition.

The following illustration shows an overview of the RFQ process.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/request-quotations.md


You can create an RFQ case from planned orders, from a purchase requisition, or by manual entry. The RFQ case

is the base document that you use to issue an RFQ to each vendor.

After you prepare the RFQ case and add vendors, select SendSend (Send and publishSend and publish for public sector) on the RFQ

case. An RFQ journal is generated for each vendor that you sent the RFQ to. You can configure the Printing

options for the Send action so that it either prints a report for each vendor to an archive or sends a report to

each vendor's email address. In addition, you can use the RFQ journal for each vendor to generate a report that

you can send or resend to the vendor later. You can also configure the Send action so that it generates a reply

sheet that the vendor can fill in.

This topic covers the process for handling RFQs when vendor collaboration isn't used. If your system is set up

file:///T:/eiye/ac1a/dynamics365/supply-chain/procurement/media/rfq-process.jpg


Setting up RFQ functionality

for vendor collaboration, vendors can enter bids directly in Supply Chain Management. For more information,

see Vendor collaboration with customers and Vendor collaboration with external vendors.

If you must amend an RFQ after you send it, you can resend the RFQ to vendors when you've finished by using

the two amendment actions: Create and Finalize.

When you receive bids by email, you can handle these bids from the Request for quotationsRequest for quotations  page.

If a second iteration of a reply from a vendor is required, select ReturnReturn on the Request for quotationRequest for quotation page.

The Return action generates a new journal and a report that will be printed, archived, and sent according to your

Printing settings.

If you added scoring criteria to your RFQ case, the RFQ will have a scoring panel where you can enter the scores.

The total scores will appear on the RFQ and when you compare the replies on the Compare repliesCompare replies  page. On

the Compare repliesCompare replies  page, you can also compare other reply data, such as the line price, delivery date, and

total price.

After you choose a bid or a number of lines in a bid, you can accept all or some lines and reject the rest.

Acceptance journals, rejection journals, and corresponding reports are generated, and will be printed, archived,

and sent according to your Printing settings. When you accept a bid or specific lines in a bid, either a purchase

agreement or a purchase order is generated, or a purchase requisition is updated, depending on the purchase

type of the RFQ. You can create a trade agreement that you can use later for any of the replies, regardless of

whether you accepted or rejected them.

An RFQ case has two statuses: lowest and highest, you can view the status on the list page for All request forAll request for

quotationsquotations . The lowest status is the least advanced stage of any line in the RFQ case, and the highest status is

the most advanced stage of any line in the RFQ case. For example, say that an RFQ case with three lines is sent

to two vendors, so there are two RFQs each with three lines. All lines are SentSent. Now a bid is entered from one of

the vendors and the RFQ lines get the status ReceivedReceived. This means that out of the three lines on the RFQ case,

all of them are SentSent for one RFQ and ReceivedReceived for another RFQ. The lowest status will then be Sent,Sent, and the

highest status is Received.Received.

These statuses will be described in more detail later in this topic.

Before you can create an RFQ case, you must set up RFQ information on the Procurement and sourcingProcurement and sourcing

parametersparameters  page. When you create an RFQ case, you can specify default values that are copied to the RFQ. You

can specify the following default values:

The purchase type of new RFQs: Purchase orderPurchase order  or Purchase agreementPurchase agreement

The expiration date and time offset from the day the RFQ case is created.

Solicitation type, which may default a specific scoring method to the RFQ case.

Delivery information and payment terms.

You can override these values for a specific RFQ case.

You should also configure the amendment process. As part of this configuration, you can turn on field locking.

When field locking is turned on, a procurement professional who wants to amend an RFQ must first select

CreateCreate in the AmendmentAmendment section of the QuotationQuotation tab on the RFQ case. Then, after the RFQ case has been

updated with the amendment, the procurement professional must complete the process by selecting FinalizeFinalize.

The Finalize action generates an email that notifies the vendors about the amended RFQ.

On the Procurement and sourcing parametersProcurement and sourcing parameters  page, you select the template to use for the email

notification that is sent to vendors. When a template is created in Email templatesEmail templates , it can contain the following

replacement tokens:

https://docs.microsoft.com/en-us/dynamics365/unified-operations/supply-chain/procurement/vendor-collaboration-work-customers-dynamics-365-operations
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%RFQ case%

%Reason for bid return%

%Reason for amendment%

%Amendment prepared by%

%Company%

%RFQ case name%

%Expiry Date Time%

%Date%

The %Reason for bid return% and %Reason for amendment% tokens are replaced by text that the procurement

professional can enter when he or she completes the amendment in the AmendmentAmendment wizard. The values for the

%Amendment prepared by% and %Company% tokens are automatically taken from the RFQ. The %Date%

token is replaced by the current date.

If you want to cancel an RFQ after it’s been sent, you can do that from the RFQ case. For the cancellation, an

email template is required to send the cancellation notification to the vendor's contact persons. The template

must be selected on the Procurement and sourcing parametersProcurement and sourcing parameters  page. When the template is created, it can

contain the following replacements tokens:

%Reason for cancellation%

%RFQ case%

%RFQ cancelled by%

%Company%

%RFQ case name%

%Date%

The %Reason for cancellation% token is replaced by text that the procurement professional can enter in the

CancellationCancellation wizard. The %Date% token is replaced by the current date.

If you want to use reason codes on a bid to indicate why it was rejected or accepted, you must set up reason

codes on the Vendor reasonsVendor reasons  page.

On the Form setupForm setup page in Procurement and sourcing, you can configure the appearance of your printed or

stored RFQ documents.

For a public-sector configuration, you must use the amendment process to change an RFQ that has already been sent.

When an RFQ is sent, fields are locked. Therefore, to make changes to the RFQ, you must select CreateCreate to start the

amendment process, as described earlier. The locking behavior is controlled by the Lock RFQ when they are sentLock RFQ when they are sent

option on the Procurement and sourcing parametersProcurement and sourcing parameters  page. By default, this parameter is set to YesYes , and for a public-

sector configuration, the default setting can't be changed. Therefore, although the amendment process can be handled

manually in a non-public-sector configuration, it must be used for a public-sector configuration.

When you create an RFQ case of the type Purchase order and add an inventory item to the RFQ, an inventory

transaction is generated that has a receipt status of Quotation receiptQuotation receipt. Only RFQ case lines that have this

status are considered when you use a master plan to calculate supplies. If you want the master plan to include

RFQ case lines as an expected receipt, you must configure this behavior in the setup of master planning.

A purchasing manager or agent can create and maintain solicitation types to suit the organization's procurement

requirements. Each solicitation type can be associated with a scoring method. Scoring methods consist of a set

of criteria that can be used when you score bids. You must set up solicitation types, scoring methods, and

scoring criteria on the Solicitation typeSolicitation type and Scoring methodScoring method pages.



 Choose default fields to include in vendor RFQ reply forms

Creating and sending an RFQ

You can specify specific types of information that you want to receive from vendors when they reply to (bid on)

a request for quotation (RFQ). Fields that you mark as default are included on the online form provided for

vendor collaboration. To make these settings:

1. If you haven't already done so, use the Feature management page to enable the Select RFQ fields to include

in vendor RFQ reply forms feature.

2. Go to Procurement and sourcing > Setup > Procurement and sourcing parametersProcurement and sourcing > Setup > Procurement and sourcing parameters .

3. Open the Request for quotationRequest for quotation tab.

4. Select the Default requests for quotationDefault requests for quotation reply fields link under the Set up default values forSet up default values for

requests for quotationsrequests for quotations  heading.

5. The Default request for quotation reply fieldsDefault request for quotation reply fields  dialog box opens.

6. The RFQ fields included in vendor RFQ reply formsRFQ fields included in vendor RFQ reply forms section includes a slider for each field that is

available for use in RFQ reply forms. Fields set to Yes in this section will be included (together with their

values) in RFQ reply forms. Set the slider to No for each field where you want to prevent vendors from

seeing data when reviewing bids. This allows you to enter estimated or expected values during RFQ entry for

internal purposes without the vendor seeing what has been entered.

You can override these settings for individual RFQ cases as needed.

You create an RFQ case, select the vendors that you want to bid on the RFQ case, and then send RFQs to the

vendors. You can use Printing settings to route the RFQ report and reply sheet reports to your preferred

destination.

You can manually create an RFQ case of either the Purchase orderPurchase order  purchase type or the PurchasePurchase

agreementagreement purchase type.

If the RFQ case is of the Purchase orderPurchase order  type, the following behavior occurs that deviates from other types of

RFQ cases:

When RFQ case lines are created, inventory transactions are generated that have a receipt status of

Quotation receiptQuotation receipt.

When you accept a bid, a purchase order is generated.

If the RFQ is of the Purchase agreementPurchase agreement type, the following behavior occurs that deviates from other RFQ

cases:

The RFQ case is used for an agreement to purchase a specific quantity or value of product over time. You

must select the date range that applies to the purchase agreement and the name of the person who manages

the purchase agreement.

When you accept a bid, a purchase agreement is generated.

If the RFQ case is generated from a purchase requisition, the Purchase requisitionPurchase requisition type is automatically

assigned. You can't manually create an RFQ case of the Purchase requisitionPurchase requisition type.

You can create an RFQ case from a purchase requisition only if the status of the purchase requisition is InIn

reviewreview  and you're assigned to do the next workflow task. The lines in the purchase requisition are automatically

updated as you accept lines from bids (RFQ replies) that you received from vendors. You can't complete, reject,

approve, or perform any other actions on the purchase requisition until the requisition line is updated with an

accepted RFQ line or the RFQ case is cancelled.

When you create an RFQ case, you can select a solicitation type. The solicitation type determines the set of

scoring criteria that is used to score RFQ replies to the RFQ case.



Amending an RFQ case

Receiving and registering RFQ replies

You can add a questionnaire to an RFQ case. This questionnaire then appears on all RFQ replies after you send

the RFQ. The completion of the questionnaire is a mandatory task before the bid can be submitted.

Although defaults are provided, you can change the RFQ fields included in vendor RFQ reply formsRFQ fields included in vendor RFQ reply forms

settings for each individual RFQ case as needed. To do so, create or open an RFQ case. Then, on the Action Pane,

open the QuotationQuotation tab and, from the RepliesReplies  section, select Set RFQ reply defaultsSet RFQ reply defaults . The Default requestDefault request

for quotation reply fieldsfor quotation reply fields  dialog box opens, which works the same as it does when setting the defaults for

vendor RFQ reply forms, except your changes here will only affect the current RFQ case. For details about how

to enable this functionality and how it works, see Choose default fields to include in vendor RFQ reply forms.

There are three ways to select the vendors to add to an RFQ case:

Add the vendors one by one.

Search for all vendors that meet specific criteria.

Automatically add all vendors that are approved for the procurement categories that are used on the RFQ

case lines.

When the RFQ case is ready, select SendSend. The Send action generates journals and reports that will be printed,

archived, and sent according to your printing settings.

If you set Use vendor for recalculating pr icesUse vendor for recalculating pr ices  and Use vendor specific item informationUse vendor specific item information to YesYes  on the

Sending request for quotationSending request for quotation page when you sent the RFQ to a vendor, some vendor-specific information

is automatically entered in the RFQ for that vendor.

Occasionally, you must change an RFQ case after you send it. You might have to change an RFQ case if, for

example, the delivery dates have changed, or you want additional products or different quantities of products.

You can configure the amendment process so that it's either more restrictive or less restrictive.

If you configure the amendment process so that it's more restrictive, before you can modify the fields on an RFQ

case that has already been sent, you must select CreateCreate on the RFQ case to start an amendment. After you've

completed your changes, you must select FinalizeFinalize. You're then guided through the process of adding

information for the email that is sent to notify vendors about the amendment. The updated RFQ report, which

includes an amendment note, is automatically attached to the email.

If you configure the amendment process so that it's less restrictive, you don't have to select CreateCreate before you

can modify the fields on an RFQ case that has already been sent. However, you must manually add an

amendment note on the RFQ and send the case again. Be aware that this approach can be used only if none of

the replies (bids) have been edited. If you've entered a reply and it's in a ReceivedReceived state, the SendSend button is

unavailable. In this case, you must select CreateCreate and then FinalizeFinalize, as you must do in the more restrictive

process. The reply is then reset to reflect the changes to the RFQ case.

If vendors use the vendor collaboration interface to enter bids, you must always use the amendment process to

notify vendors about changes to the RFQ case. This process helps prevent the situation where vendors bid on an

outdated RFQ case while their bid is in progress. For more information about vendor collaboration, see Vendor

collaboration with external vendors.

If you want to invite additional vendors to bid, and no changes have been made to the RFQ case, you can use the

SendSend button. The vendors that you added will appear on the SendSend page and will receive the email invitation.

When you send an RFQ, a reply sheet is automatically generated. As you receive bids on an RFQ, you must enter

them via the Request for quotationRequest for quotation page by clicking the action Edit RFQ reply.Edit RFQ reply. This will allow you to enter

the bid information in a dedicated bid form. Initially, the Reply progressReply progress  will be Not star tedNot star ted. When you click

https://docs.microsoft.com/en-us/dynamics365/unified-operations/supply-chain/procurement/vendor-collaboration-work-external-vendors


Accepting and rejecting bids, and transferring accepted bids to downstream documentsAccepting and rejecting bids, and transferring accepted bids to downstream documents

Statuses – highest and lowest

Edit RFQ reply,Edit RFQ reply, the progress status is Purchaser is updatingPurchaser is updating until the bid is submitted. Click SubmitSubmit when

you have entered the bid information. The Reply progress status will change to Submitted by purchaser.Submitted by purchaser.

Similarly, with vendor collaboration enabled, the Reply progressReply progress  will update as the vendor interacts with the

bid. The status then changes from Vendor is updatingVendor is updating to Submitted by vendorSubmitted by vendor . When the bid is submitted,

a journal is created as ReceivedReceived. The reply (bid) has to be submitted in order to be registered as received, and

only then it can be further processed as accepted or rejected.

If you need to update the bid, you should go through the same process as above and submit again.

Note that editing the Request for quotationRequest for quotation form is only allowed for information that relates to processing

the bid, not for entering the bid. To enter or modify the bid, click Edit RFQ reply.Edit RFQ reply.

When you enter the bid information, and if the RFQ case allows for alternate lines, you can add alternate lines

for lines that only have a procurement category and no catalog item specified,. Click Add alternateAdd alternate to add

alternate lines.

If you've entered a reply but require a new offer from the vendor, you can return the RFQ. A new journal and a

report are generated, that can be sent to the vendor.

You can see an overview of all RFQs and their statuses: Sent, Received, Accepted, Rejected, Cancelled,Sent, Received, Accepted, Rejected, Cancelled,

DeclinedDeclined on the Request for quotation follow-upRequest for quotation follow-up page.

After you've identified the best bid, such as the bid that offers the best total price, you accept the bid. You can

accept some lines in a bid and reject others. You can also accept lines from different vendors. Be aware that if

you accept some lines, you're prompted to reject all the other lines. Therefore, if you want to accept other lines,

you must select CancelCancel  when you're prompted. The status of the RFQ reply for each vendor that you accept bids

or lines from is updated to AcceptedAccepted.

If you, while you prepare the purchase order or purchase agreement, need to add an additional line to the RFQ,

you can do so by clicking Add lineAdd line on the Request for quotationRequest for quotation page line grid. You can only view and edit

this line in Request for quotationRequest for quotation page. It will be visible on the bid page when it is accepted.

When you accept a bid or one or more lines in a bid, a purchase order or a purchase agreement is automatically

generated. You can then reject the bids from all the other vendors.

On the reply, you can add a reason code to explain why you accepted or rejected a bid.

When you accept a bid of the Purchase requisitionPurchase requisition type, the purchase requisition lines will be updated with

the following information that reflects the information of the accepted bid:

Unit price

Discount percentage

Discount amount

Purchase charges

Line charges

Vendor

External number

External description

The following table shows how the RFQ status changes as you accept and reject bids from vendors.

On the Vendor tab of the RFQ case, you can see the lines with the highest and the lowest status for a particular

vendor. When the vendor is added, and no lines have yet been sent, both the lowest and the highest status is
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second
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Created.Created. When the RFQ is sent to the vendor with all lines, the status of the two lines will be SentSent. If some lines

in a bid from a vendor are accepted and others are rejected, the rejected lines will get the lowest status which is

RejectedRejected, and the accepted lines will get the highest status which is AcceptedAccepted.

On the RFQ case lines, you can see the highest and the lowest status per line across all vendors. If you have sent

a line to all the vendors in the RFQ case and no one have responded yet both the lowest and the highest status

is Sent.Sent. When at least one vendor responds, the highest state will change to ReceivedReceived. If you add a new vendor

to the case, the lowest status will change to CreatedCreated

The highest and the lowest status on the RFQ case is an aggregation of the status on the <Vendor tab and the

Lines tab.

The statuses are ranked in the following way from lowest to highest: Created, Sent, Received, Rejected, Accepted,

Declined, Canceled.

The following table shows how the RFQ case status changes when you create an RFQ case with lines and then

send it to vendors.

All the lines on the RFQ’s that are related to the RFQ case will be in SentSent state.

The following table shows how the RFQ status changes as you receive bids and register the information on the

RFQ reply sheet.

In the example below you can see the highest and lowest status on the RFQ case where one bid has been

received and the other bid has been accepted. When a received bid is rejected, the lowest status will change

from received to rejected on the RFQ case header and line.



A C T IO NA C T IO N

LO W ESTLO W EST
STAT USSTAT US
A C RO SS A L LA C RO SS A L L
L IN ES O F  A L LL IN ES O F  A L L
RF Q SRF Q S

H IGH ESTH IGH EST
STAT USSTAT US
A C RO SS A L LA C RO SS A L L
L IN ES O F  A L LL IN ES O F  A L L
RF Q SRF Q S

LO W EST  RF QLO W EST  RF Q
C A SE H EA DERC A SE H EA DER
STAT USSTAT US

H IGH EST  RF QH IGH EST  RF Q
C A SE H EA DERC A SE H EA DER
STAT USSTAT US

LO W EST  RF QLO W EST  RF Q
C A SE L IN EC A SE L IN E
STAT USSTAT US

H IGH EST  RF QH IGH EST  RF Q
C A SE L IN EC A SE L IN E
STAT USSTAT US

Accept one of
the bids. (or
at least one
line)

Received Accepted Received Accepted Received Accepted

Reject all the
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Prepare a new RFQ

Add lines

Add vendors

This procedure shows you how to create a request for quotation. This would typically be done by a purchasing

agent. You can use this procedure in demo data company USMF or on your own data. You need to have set up

solicitation types before you start. Once you've completed this task and you've created and sent an RFQ you can

then enter the replies per vendor, compare them, and award the contract.

1. Go to Navigation pane > Modules > Procurement and sourcing > Requests for quotations > AllNavigation pane > Modules > Procurement and sourcing > Requests for quotations > All

requests for quotationsrequests for quotations .

2. Click NewNew . The following purchase types are available: Purchase order (this is the default): a document that

confirms the offer to buy products, or the acceptance of an offer to sell products in exchange for payment.

Purchase requisition: this type is automatically selected if you create an RFQ directly from a purchase

requisition. If you manually select this option, you'll get an error. Purchase agreement: an agreement to

purchase a specific quantity or value of product over time. If you select this option, you must select the date

range that applies to the purchase agreement.

3. In the Document titleDocument title field, type a value.

4. In the Solicitation typeSolicitation type field, enter or select a value.

5. In the Warehouse fieldWarehouse field, enter or select a value. The delivery address will default to the warehouse address.

6. Click OKOK.

If a scoring method is associated with the solicitation type, this will be the default scoring method for

the RFQ that you're creating. It is possible to change the scoring method later.

In the Deliver y dateDeliver y date field, enter a date.

Select the date by which you want to receive the items.

In the Expiration date and timeExpiration date and time field, enter a date and time.

Specify the date and time by which vendors must respond to the RFQ.

After you've specified the basic information about your RFQ, you specify the goods or services that you want

vendors to bid on. Item is the default line type.

1. In the Item numberItem number  field, enter or select a value. If you're using USMF, you can select T0020.

2. In the QuantityQuantity  field, enter a number.

3. Click Add lineAdd line.

4. In the L ine typeLine type field, select 'Category'. You can use the Category line type to create RFQs for non-inventory

goods or services. You then need to select the type of goods or services from a hierarchy of procurement

categories.

5. In the Procurement categor yProcurement categor y  field, enter or select a value.

6. In the Product nameProduct name field, type a value.

7. In the QuantityQuantity  field, enter a number.

8. In the UnitUnit field, enter or select a value.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/tasks/create-request-quotation.md


Send the RFQ to vendors

View the RFQ journal

NOTENOTE

1. Click HeaderHeader  to change from the Lines view to the Header view.

2. Expand the VendorVendor  section.

3. Click Auto-add vendorsAuto-add vendors . You can add vendors to the RFQ automatically, based on the procurement

category of the items requested. If there are no vendors approved for the categories included in the lines you

can add vendors manually.

4. Click AddAdd.

5. In the Vendor accountVendor account field, enter or select a value.

6. Click AddAdd.

7. In the Vendor accountVendor account field, enter or select a value. Once you've selected a vendor, the status is Created.

This means that the vendor information has been saved in the RFQ, but you have not sent the RFQ to the

vendor. You can add a vendor to an RFQ regardless of the vendor status.

1. On the Action PaneAction Pane, click SendSend. In the Sending request for quotation page, check that the vendors in the list

are the ones that you want to receive the RFQ.

2. Click Pr intPr int. This dialog allows you to print the RFQ. If you choose to print a reply sheet, the contents of this

are defined in Procurement and Sourcing parameters. To choose how to print reply sheets, once you've

opened the Print dialog, click Advanced printing options. One RFQ will be printed for each vendor containing

the lines that have the status of Created or Sent. Canceled lines and lines with registered replies will not be

printed.

3. Click CancelCancel .

4. Click OKOK.

5. Close the page.

6. Close the page.

1. Go to Procurement and sourcing > Requests for quotations > Request for quotations follow-upProcurement and sourcing > Requests for quotations > Request for quotations follow-up

> Request for quotation journals> Request for quotation journals .

2. Click Preview/PrintPreview/Print.

3. Click Original previewOriginal preview .

4. Close the page.

5. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a requisition that uses an RFQ
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Create a requisition

Reassign a workflow task

This topic explains how to add price and vendor information to a purchase requisition from an RFQ process. The

example shown in this guide can be used in the USMF demo data company, and you must be logged in as an

Admin to complete all the steps. The tasks in this guide would typically be done by procurement professionals.

1. In the navigation pane, go to Modules > Procurement and sourcing > Purchase requisitions >Modules > Procurement and sourcing > Purchase requisitions >

Purchase requisitions prepared by mePurchase requisitions prepared by me.

2. Select NewNew .

3. In the NameName field, type a value.

4. In the Requested dateRequested date field, enter a date.

5. In the Accounting dateAccounting date field, enter a date.

6. Select OKOK.

7. In the ReasonReason field, enter or select a value.

8. Select Add lineAdd line.

9. In the Procurement categor yProcurement categor y  field, select a category in the tree, and then select OKOK.

10. In the Product nameProduct name field, type a value.

11. In the QuantityQuantity  field, enter a number.

12. In the UnitUnit field, enter or select a value.

13. Select SaveSave.

14. Select WorkflowWorkflow  to open the drop dialog.

15. Select SubmitSubmit.

16. Close the page.

17. Select SubmitSubmit.

The next task is to create an RFQ to get bids from vendors for the product. In USMF demo data, the requisition

workflow is set up with a rule so that if a vendor is not selected, or the unit price is 0 for a line, a task is assigned

to a specific worker to create an RFQ. To continue with this guide, you need to re-assign that task to another user

(yourself). You can only do this if you are logged in as an Admin.

1. Select WorkflowWorkflow  to open the drop dialog.

2. Select View histor yView histor y .

3. Refresh the page.

4. Expand the Tracking detailsTracking details  section.

5. In the tree, select the line that starts with "Line workflow activated on".

6. Select View workflow detailsView workflow details .

7. Expand the Work itemsWork items section.

8. Select ReassignReassign.

9. In the UserUser  field, select AdminAdmin.

10. Select ReassignReassign.

11. Close the two pages.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/tasks/create-requisition-uses-rfq.md


Create an RFQ

Verify that vendor and price have been transferred to the requisition

NOTENOTE

1. Refresh the page.

2. Select Request for quotationRequest for quotation.

3. In the Buying legal entityBuying legal entity  field, select USMFUSMF. You must select the same legal entity that's on the requisition

line.

4. In the list, mark the selected row. If you had multiple lines on your purchase requisition, select all the lines

that you want to add to the RFQ.

5. Select OKOK.

6. Refresh the page.

7. Ensure that the FactBox is open, then expand the Related documentsRelated documents  section.

8. Select the link in the Request for quotationRequest for quotation field to open the RFQ that was just created.

9. Select HeaderHeader .

10. Select AddAdd.

11. In the Vendor accountVendor account field, enter or select a value.

12. Select AddAdd.

13. In the Vendor accountVendor account field, enter or select a value.

14. Select SendSend.

15. Select OKOK.

16. Select Enter replyEnter reply .

17. On the Action Pane, select ReplyReply .

18. Select Copy data to replyCopy data to reply . This copies data, such as the quantity and dates, from the RFQ to the reply.

19. In the Unit pr iceUnit pr ice field, enter a number. This is the price that you've received from the vendor. You might also

want to enter additional information from the vendor.

20. Select AcceptAccept.

21. Select OKOK.

1. Close the page.

2. Select L inesLines .

3. Select Related informationRelated information.

4. Select Purchase requisitionPurchase requisition.

5. Select the line that was transferred to the RFQ. Verify that the price and vendor have been copied to the

requisition.

6. Select WorkflowWorkflow  to open the drop dialog.

7. Select Complete.

8. Select the page.

9. Select Complete.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

This procedure shows you how to create a scoring method. A scoring method is a set of criteria that can be used

to compare bids that are sent in reply to a request for quotation (RFQ). For example, you might want to rate a

vendor on past performance, or rate whether the company is environmentally friendly or a good collaborator, or

you might want to compare bids based on price. The scoring method can be associated with a solicitation type

as the default scoring method for RFQs of that type. These tasks would typically be carried out by a purchasing

manager. You can use this procedure in demo data company USMF or on your own data.

1. Go to Procurement and sourcing > Setup > Request for quotation > Scoring method.

2. Click New.

3. In the Name field, type a value.

4. In the Description field, type a value.

5. Click Save.

6. Click New.

7. In the Name field, type a value.

8. In the Description field, type a value.

9. In the Range from field, enter a number.

10. In the Range to field, enter a number.

11. Click New.

12. In the Name field, type a value.

13. In the Description field, type a value.

14. In the Range from field, enter a number.

15. In the Range to field, enter a number.

This description is shown along with the scoring method name when a scoring method is selected for

an RFQ.

The range limits what the procurement professional can enter as a score. When there are multiple

scoring criteria on an RFQ, the scores that have been entered are added to each other and the sum is

made available to allow the bids to be compared.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/tasks/create-scoring-method-rfqs.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create solicitation types and scoring criteria for
RFQs
2/18/2021 • 2 minutes to read • Edit Online

Create a solicitation type

Use the solicitation type

NOTENOTE

This guide shows you how to create a solicitation type and associate this with a scoring method. It also shows

how to use the solicitation type on a request for quotation (RFQ) which then sets the default scoring method.

These tasks would typically be carried out by a purchasing manager. You can use this procedure in demo data

company USMF or on your own data. You need to have a scoring method available before you start.

1. Go to Procurement and sourcing > Setup > Request for quotation > Solicitation type.

2. Click New.

3. In the Name field, type a value.

4. In the Description field, type a value.

5. In the Scoring method field, select the scoring method that you want to use for this solicitation type.

6. Click Save.

7. Close the page.

1. Go to Procurement and sourcing > Requests for quotations > All requests for quotations.

2. Click New.

3. In the Solicitation type field, select the solicitation type that you have just created. *

4. Click OK.

5. Click Scoring criteria.

6. Click Copy criteria.

7. In the Scoring method field, enter or select a value.

8. Click OK.

9. Close the page.

The scoring criteria that are shown are the ones from the scoring method that you associated with the

solicitation type. You can choose to add or delete criteria on this page. It's also possible to add new

criteria by copying them from other scoring methods.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/tasks/create-solicitation-types-scoring-criteria-rfqs.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Responding to vendor questions on Request for
quotations
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Turn on the feature

Allow questions and answers to be used in RFQs

Setting up for vendor questions

When your agency has sent a request for quotation (RFQ), vendors sometimes have questions that pertain to

the request. Vendors that have questions related to an RFP can submit their questions and read the answers on

Vendor collaborationVendor collaboration page, when you make that page available to them. When vendor questions are

accepted, Questions and answersQuestions and answers  is available on the Request for quotation bidRequest for quotation bid page on VendorVendor

collaborationcollaboration, and for your agency through the Request for quotationRequest for quotation page, Questions and answersQuestions and answers .

Users can publish answers to vendor questions more than once. Vendors can't no longer post questions after a

vendor is selected and the RFQ is awarded, or after the cutoff date for questions is reached.

Before you can use this feature, it must be turned on in your system. Admins can use the feature management

settings to check the status of the feature and turn it on. In the Feature managementFeature management workspace, the feature is

listed in the following way:

Module:Module: Procurement and sourcing

Feature name:Feature name: RFQ questions and answers

1. Go to Procurement and sourcing > Setup > Procurement and sourcing parametersProcurement and sourcing > Setup > Procurement and sourcing parameters .

2. Open the Request for quotationRequest for quotation tab.

3. Set the following options as needed:

Allow vendor questionsAllow vendor questions : Enables or disables vendor questions for RFQ cases. You must set this to

Yes to use the features described in this topic.

Default direct responseDefault direct response: When you reply to a question, you can choose to reply to all vendors who

received the RFQ or to reply only to the specific vendor who submitted the question. You can make

choose this option each time you reply, but this setting controls the default. If you usually reply to all

vendors, set this to No. If you usually reply to individual vendors, set this to Yes.

When creating a request for quotation, you determine whether vendors can ask questions about the RFQ.

1. Navigate to Procurement and sourcing > Requests for quotationsProcurement and sourcing > Requests for quotations  then click New > Request forNew > Request for

quotationquotation

2. In the New request for quotationNew request for quotation page, HeaderHeader  to set the Vendor question optionsVendor question options  fields to allow

questions before a certain date.

3. Set the Allow vendor questionAllow vendor question option to YesYes  so the vendors can enter questions. Users can enter and

answer questions and designate commonly asked questions to publish for vendors when the RFQ is sent to

vendors.

4. Optional: In the Cutoff dateCutoff date field, define the final date by which questions must be submitted. If no cutoff

date is entered, questions are accepted as long as the RFQ is open and accepting bids.

5. Click SaveSave to save the RFQ.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/rfq-question.md


Entering and replying to vendor questions

Entering a vendor question

Replying to a single vendor

Replying to all vendors

6. Click SendSend to send the RFQ to the vendors for bidding.

Vendors enter questions in the Vendor Collaboration > Request for quotations bidVendor Collaboration > Request for quotations bid page, VendorVendor

questionsquestions  FastTab. The question is visible only to the vendor and users.

NOTENOTE

1. In Vendor collaboration, in the Request for quotation bidRequest for quotation bid page, click Questions and answersQuestions and answers , and

then click + Ask a question+ Ask a question.

Alternately, a user can enter questions for a vendor on the Request for quotationRequest for quotation page, by clicking ManageManage

repliesreplies , Edit RFQ replyEdit RFQ reply  then clicking Questions and asnwersQuestions and asnwers .

2. On the QuestionQuestion field, enter the question text.

3. Click the SubmitSubmit. Repeat steps 1-3 to add a question.

4. When done, click SaveSave to save your questions.

The question and answer are visible only to the vendor and users.

1. On the Request for quotationsRequest for quotations  page, click the Questions and answersQuestions and answers  to display the Questions andQuestions and

answersanswers  page.

2. Click EditEdit.

3. Enter text in the AnswerAnswer  field to respond to the vendor's question.

4. Check the Direct responseDirect response box.

5. Click SaveSave to save your replies.

6. Click Send answersSend answers  to send the answers to the vendor.

If you receive the same question from multiple vendors, you can group the questions and respond with one

answer. All vendors receive notification when the commonly asked questions and answers are published. The

vendors and anyone with access to the request for quotation can view the summary of questions and answers.

1. On the Request for quotationsRequest for quotations  page, click the Questions and answersQuestions and answers  to display the Questions andQuestions and

answersanswers  page.

2. Click EditEdit.

3. Choose a code for the common question, such as the letter 'a.'

4. For each line that asks a similar question, enter the code in the Group codeGroup code field. For example, for each line

asking about item color, enter 'a.'

5. Choose one of the lines with the code value, and enter the question and answer the way you want them to

read in the summary that will be available when the questions and answers are published (Group question,Group question,

Group answerGroup answer  fields).

6. Optional: You can mark the Direct responseDirect response check box to send the answers only to the selected vendors.

7. Click SaveSave to save your answers.

8. Optional: You can revert the questions and answers to the previously published values if you want to undo



Changing RFQ to allow or disallow questions

IMPORTANTIMPORTANT

NOTENOTE

your changes.

9. Click Send answersSend answers  to send your answers to the vendors.

You can make changes to allow or disallow questions to RFQs until the RFQ is awarded. You can also extend or

shorten the time frame in which vendors can submit questions. For published RFQs, you must modify a request

for quotation to allow or disallow vendor questions or adjust the time frame for questions.

If you amend an existing RFQ for the purpose of allowing vendor questions, the system will clear all existing responses

when you resend the RFQ.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Enter a reply as a vendor

Enter a reply from a vendor as a procurement professional

This topic explains how to enter replies to a request for quotation (RFQ), score and compare bids, and then

award the contract to one of the vendors. You can use this procedure in the USMFUSMF demo data company.

Before you start this procedure, you must have an RFQ that has two lines, and that has been sent to at least two

vendors. To create this RFQ, complete the Create a request for quotation procedure. Scoring criteria must also be

set up before you can complete this procedure.

You can enter the bid as either a vendor or a procurement professional. For more information, see Set up and

maintain vendor collaboration.

1. On the dashboard, select Vendor biddingVendor bidding.

2. In the New bid invitationsNew bid invitations  list, find an RFQ that was just sent. Select the RFQ to review what was

requested.

3. Select RFQ attachmentsRFQ attachments  to review any attachments that have been added.

4. Select BidBid to make the fields editable. Notice that the Bid progressBid progress  field is set to Vendor is updatingVendor is updating.

5. On the header and lines, enter the values from the bid reply.

6. If any attachments should be added to the bid, select Bid attachmentsBid attachments .

7. Select the Bidding guiding itemsBidding guiding items FastTab to view whether any documents are required.

8. Select the AmendmentsAmendments  FastTab to view whether the RFQ has been amended.

9. Select the QuestionnaireQuestionnaire FastTab. Any questionnaires that appear here must be answered.

10. Select the L ine detailsL ine details  FastTab to view extended information about the line.

11. Select Reset from RFQReset from RFQ only if you must reset the values that have been entered to the original RFQ values.

12. You can save the bid at any time and do additional processing later, provided that the expiration date and

time haven't passed. In this case, you can find the bid in the Bids in progressBids in progress  list in the Vendor biddingVendor bidding

workspace.

13. When the bid is ready to be sent, select SubmitSubmit. If you don't want to bid, select DeclineDecline. Submitted bids are

available in the Submitted bidsSubmitted bids  list in the Vendor biddingVendor bidding workspace.

14. After the bid is submitted, you can recall it at any time before the expiration date and time. Note that when a

bid is recalled, it isn't treated as submitted. When the bid is accepted or rejected by the procurement

department, it appears in either the Awarded bidsAwarded bids  or Lost bidsLost bids  list in the Vendor biddingVendor bidding workspace.

1. Make sure that the permission to edit vendor bids is set up. Go to Procurement and sourcing > Setup >Procurement and sourcing > Setup >

Procurement and sourcing parametersProcurement and sourcing parameters . On the Request for quotationsRequest for quotations  tab, set the Purchaser canPurchaser can

edit vendors bidedit vendors bid option to YesYes .

2. Go to Procurement and sourcing > Requests for quotations > All requests for quotationsProcurement and sourcing > Requests for quotations > All requests for quotations .

3. Select an RFQ that has a status of SentSent, and then select the link in the Request for quotation caseRequest for quotation case field.

4. Select Manage repliesManage replies . The page that appears shows an RFQ for each vendor that was invited to bid.

5. Select an RFQ that hasn't been replied to. (The Reply progressReply progress  field should be set to Not star tedNot star ted.)

6. Select Edit > Edit RFQ replyEdit > Edit RFQ reply . The RFQ replyRFQ reply  page appears. As a procurement professional, you can now

enter the reply on behalf of the vendor. Notice that the Bid progressBid progress  field is set to Purchaser is updatingPurchaser is updating.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/tasks/enter-compare-rfq-bids-award-contracts.md


Score the bids

Compare the replies

Reject a bid

7. Enter the bid data. When you've finished, select SubmitSubmit.

1. On the All requests for quotationsAll requests for quotations  page, select the RFQ case that you want to score replies for.

2. Select Manage repliesManage replies .

3. Select the reply to score.

4. Select HeaderHeader  so that you can view the scoring for the bid.

5. On the Bid scoringBid scoring FastTab, enter a number in the ScoreScore field for one of the scoring criteria. If you hover

over a scoring criterion, a tooltip shows the range that the score must be within. In this demo, you can enter a

number between 1 and 5 for any of the scoring criteria.

6. Repeat step 5 for another scoring criterion.

7. If the RFQ case has a questionnaire that was sent to the vendors, you can enter the vendor responses on the

QuestionnairesQuestionnaires  FastTab.

8. Close the page.

9. Repeat steps 1 through 8 for all the other bids.

1. On the Action Pane, on the GeneralGeneral  tab, select Compare repliesCompare replies .

2. In the RankRank field, enter a number.

3. Select the header line for the other bid that you want to rank.

4. In the RankRank field, enter a number.

5. Select SaveSave.

This page shows the bids, together with the header and line information, and also the total score at the

header level. You can compare the lines by sorting the grid so that comparable lines are next to each

other. The following information is also included:

QuantityQuantity  – The quantity that the vendor quoted. This quantity might not equal the quantity that is

specified in the RFQ.

Net amountNet amount – The price that the vendor quoted for the items on the line, minus any discounts.

DeviationDeviation – The number of days by which the delivery date on the bid header or line differs from the

requested delivery date on the RFQ header or line. You can enter a rank for each bid.

1. Select the header line for the bid that you want to reject. You can accept, reject, or return only one bid or the

lines on only one bid at a time.

2. Select the MarkMark check box.

3. Select RejectReject.

4. Select ParametersParameters , and then, in the Reason rejectReason reject field, enter or select your reason for rejecting the bid.

The reason is stored in the reply.

5. Select OKOK.

6. Select OKOK.

If you select the MarkMark check box on the header of the bid, all the lines are also marked. To reject or

accept only some of the lines on the bid, you can mark just those lines. Additionally, you can accept

one vendor's bid for some lines of an RFQ and then award other RFQ lines to a different vendor.

However, you must do one bid at a time.

If alternate lines are present, you can accept either the original bid line or its alternate, but not both.



Accept a bid

View the purchase order that is generated

NOTENOTE

1. Select the bid to accept, and then select the link in the Request for quotationRequest for quotation field. If you're on the

Compare request for quotation repliesCompare request for quotation replies  page, the highlighted bid that has focus is the bid that the

system will consider during the Accept action. You can accept lines from only one bid at a time.

2. On the Action Pane, select ReplyReply .

3. Select AcceptAccept. If you marked only specific lines, the Accept action will include only those lines. If you want to

accept all the lines on the bid, you don't have to mark the lines.

4. Select ParametersParameters , and then, in the Reason acceptReason accept field, enter or select your reason for accepting the bid.

The reason is stored in the bid.

5. Select OKOK.

6. Select OKOK. When you select OKOK, a purchase order is generated based on the lines that are included in the

RFQ acceptance. If there are other bids that haven't been processed (accepted, rejected, or returned), the

system prompts you to reject them.

On the Action Pane, on the GeneralGeneral  tab, select Purchase orderPurchase order . The page that appears shows the purchase

order that was generated when you accepted the bid.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Types of purchase orders

P O  T Y P EP O  T Y P E DESC RIP T IO NDESC RIP T IO N

Journal Use this type to create a draft order. This type doesn't affect
stock quantities or generate inventory transactions. The PO
journal lines aren't included in master scheduling.

Purchase order Use this type to create POs when orders are confirmed with
a vendor, and as the orders are processed through receipt
and invoicing before payment is made to the vendor. This
type of PO is the most common.

This article provides general information about purchase orders (POs) and links to additional articles that are

related to the various stages that a PO goes through.

A purchase order (PO) is a document that represents an agreement with a vendor to buy goods or services. The

document also helps keep track of product receipts that are made toward the order and, later, the accounting of

vendor invoices that the vendor bills toward the order.

The Purchase ordersPurchase orders  page contains an overview of the available orders and lets you modify those orders.

When you open a PO, you can select the HeaderHeader  view, which contains information that is specified only one

time for each PO, such as the vendor details. Alternatively, you can select the L inesLines  view, where you can modify

order lines. Typically, you will switch between these two views as you modify POs. Charges aren't listed directly

on the Purchase ordersPurchase orders  page, but are accessed via menus on the order header and lines.

There are many reports where you can view information about POs, product receipts, and vendor invoices.

These reports are found in the Procurement and sourcingProcurement and sourcing and Accounts payableAccounts payable modules.

The Purchase order preparationPurchase order preparation and Purchase order receipt and follow-upPurchase order receipt and follow-up workspaces let you view lists

of POs in the various states that they have progressed to. They also provide a summary of the actions that must

be taken. The Purchase order preparationPurchase order preparation workspace is focused on PO creation and review, processing of the

order through approval, and confirmation with the vendor. The Purchase order receipt and follow-upPurchase order receipt and follow-up

workspace is focused on processing the receipt of goods or services against POs. It includes lists that give

insight into receipts that are overdue, or that will soon be due for delivery by the supplier. These workspaces

aren't used to perform the related receipt activities that are done in the warehouse. Those activities are

performed by using pages in the Inventor y managementInventor y management and Warehouse managementWarehouse management modules.

Processing of vendor invoices should be done by using the Vendor invoice entr yVendor invoice entr y  workspace, and payments

should be done by using the Vendor paymentsVendor payments  workspace.

The following articles provide an overview of the various stages that a PO goes through:

Create purchase orders

Approve and confirm purchase orders

Product receipt against purchase orders

Overview of vendor invoices

There are three types of POs. When you create a PO, you must specify the type. You can set up a default order

type for new orders on the Procurement and sourcing parametersProcurement and sourcing parameters  page.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/purchase-order-overview.md
file:///T:/eiye/ac1a/dynamics365/financials/accounts-payable/vendor-invoices-overview.html


Returned order Use this type when you return goods to the vendor. This
type of order requires that you specify the return material
authorization (RMA) number that the vendor gives you. You
specify the RMA number on the GeneralGeneral tab of the PO. The
order lines must have negative quantities.
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Purchase order statuses

Additional resources

POs include several status fields that indicate the progress of the order. All these fields are visible in the HeaderHeader

view of the order, and a few of them are also visible in the grid overview of all orders. The StatusStatus  field show the

status for quantities on the order. The following values are available:

Open orderOpen order  – Orders have been created, and quantities are on order.

ReceivedReceived – Some of the quantities have been received, but they haven't been invoiced yet.

InvoicedInvoiced – The full quantity on the order has been invoiced. Note:Note: If an order has been partially invoiced,

neither ReceivedReceived status nor InvoicedInvoiced status is appropriate. Therefore, the order will still have a status of

Open orderOpen order .

CanceledCanceled – An order was confirmed but later canceled. Therefore, this status indicates that there are no

longer any open quantities on order.

The Document statusDocument status  field helps you quickly review the order's progress in terms of documents that have

been processed. It shows the status of the most recent document that has been completed for the order. The

following values are available:

NoneNone – No document has been processed for the order yet.

Purchase inquir yPurchase inquir y  – A purchase inquiry has been generated, and the order is awaiting feedback from the

vendor.

Purchase orderPurchase order  – Confirmation has been processed on the order.

Product receiptProduct receipt – Product receipt has been processed on the order.

InvoiceInvoice – An invoice has been accounted with the order.

The Approval statusApproval status  field is used when a PO goes through a review process or workflow. The following values

are available:

DraftDraft, In reviewIn review , and RejectedRejected – These statuses are used only when an approval workflow is used for the

PO.

ApprovedApproved – This status is assigned to orders that have completed workflow approval. Orders that are

created without using an approval workflow receive a status of ApprovedApproved immediately.

In external reviewIn external review  – This status is used in scenarios where a purchase inquiry is sent to the vendor, so that

the vendor can confirm terms of the PO. This status is also used in the process that is initiated by the

Confirmation requestConfirmation request action. For this process, the vendor is asked to confirm terms of the PO by

connecting to your system and registering whether it confirms or rejects the order.

ConfirmedConfirmed – This status is assigned after the order has been confirmed. Typically, this status is the last

approval status that is assigned to an order.

Create purchase orders

Approve and confirm purchase orders

Product receipt against purchase orders
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Overview of vendor invoices

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/financials/accounts-payable/vendor-invoices-overview.html
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Approval of purchase orders
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Draft The PO is a draft and hasn't been
submitted for approval in the PO
workflow.

No

In review The PO was submitted for approval in
the PO workflow. Approval is pending.

No

Rejected The PO was rejected during the
approval process.

No

Approved The PO was approved. Yes

Confirmed The PO was confirmed. A PO can't be
confirmed until it has been approved.

Yes

Finalized The PO was made final. It's now
financially closed and can no longer be
changed.

No

Confirming purchase orders

This topic describes the statuses that a purchase order (PO) goes through after it has been created, and the

effect of enabling change management on POs.

After a purchase order (PO) has been created, it might have to go through an approval process. After the vendor

has agreed to the order, the PO is set to a status of ConfirmedConfirmed.

POs that don't use change management have a status of ApprovedApproved as soon as they are created, whereas POs

that use change management have a status of DraftDraft when they are first created. A PO that has been created by

firming a planned order from master planning is always set to a status of ApprovedApproved, regardless of the change

management settings. A PO creates inventory transactions only when it reaches the ApprovedApproved status.

Therefore, that inventory doesn't appear as available for reservation or marking until the order is accepted.

You enable change management for POs by setting the Activate change managementActivate change management option on the

Procurement and sourcing parametersProcurement and sourcing parameters  page. When change management is enabled, POs must go through

an approval workflow after they have been completed. Supply Chain Management has a workflow process

editor where you can define a workflow to represent your approval process. This workflow can include rules for

automatic approval, rules that determine who will be assigned to approve particular POs, and rules for

escalating a workflow that has been waiting for approval for a long time. You can enable the change

management process for all vendors or for specific vendors. You can also set up the process so that it can be

overridden for individual POs.

When change management is enabled, POs move through six approval statuses, from DraftDraft to FinalizedFinalized. After

an order has been approved, users who want to modify it must use the Request changeRequest change action.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/purchase-order-approval-confirmation.md


Changing purchase orders

Canceling purchase orders

POs that have an approval status of ApprovedApproved can go through additional steps before they are confirmed. For

example, you might have to send a purchase inquiry to the vendor to inquire about prices, discounts, or delivery

dates. In this case, you can set the PO to the In external reviewIn external review  status by using the Purchase inquir yPurchase inquir y  action.

Vendors that are set up to use the Vendor portal can review orders on the portal, and approve or reject them.

During this review process, the PO has a status of In external reviewIn external review . The Vendor portal can be configured so

that a confirmation from the vendor automatically confirms the order in Supply Chain Management.

Alternatively, you can manually confirm a PO after you receive confirmation from the vendor. If a vendor rejects

a PO, the rejection is received together with the reason for the rejection and suggestions for changes. In this

case, the status of the PO remains In external reviewIn external review .

There is also an option to generate a pro-forma confirmation for an order before the actual confirmation has

been processed. This option just creates a report that you can share with the vendor. It doesn't create any journal

information.

After the vendor has agreed to the order, the next step is to record the PO as committed. You can complete this

step by using either the ConfirmationConfirmation action or the ConfirmConfirm action. Both these actions set the approval status

of the order to ConfirmedConfirmed. Confirmation of an order initiates two additional processes:

A journal is created to store an exact copy of what was confirmed in the system. Sometimes, orders require

changes, and additional journals are created after the updated order is confirmed. These journals let you view

the history of the various versions of the order that were confirmed.

Accounting distributions are created, and order checks and budget checks occur if this functionality has been

enabled. If either check fails, you receive an error message that states that changes must be made to the PO

before it can be confirmed again.

A vendor might request some type of assurance that payment will be provided for a purchase. There are various

methods for providing this guarantee within accounts payable processes. For example, the PrepaymentPrepayment action

reserves funds for the PO, and this prepayment is recorded on the PO.

In some situations, you might have to change a PO after it has reached an approval status of ApprovedApproved or

ConfirmedConfirmed.

If the PO was created by using a change management process, you can make changes by recalling the order or,

if the order has already been approved, by using the Request changeRequest change action. In this case, the approval status is

changed back to DraftDraft, and you can then modify the order. After you've finished making changes, you might

have to submit the PO for re-approval. You can configure the types of changes that require re-approval by using

a Re-approval rule for purchase ordersRe-approval rule for purchase orders  policy rule on the Purchasing policiesPurchasing policies  page.

If part of the ordered quantity for a PO line has been delivered, you can't change the ordered quantity when the

purchase order is in DraftDraft. However, you can change the Deliver remainderDeliver remainder  quantity on the line for the

purchase order that is in DraftDraft status.

After an order has been confirmed, you can no longer delete it. However, you can cancel the total quantity or any

remaining quantity on an order, provided that the quantity hasn't been received or invoiced. You can then use

the FinalizeFinalize action to prevent further processing.

A PO can be canceled by using the CancelCancel  action on the header.

If the quantity has been partially registered, received, or invoiced, you can cancel only the remaining quantity

that hasn't been registered, received, or invoiced. The order quantity is then reduced accordingly. When the

quantity on the line is updated, the line status is also updated. For example, the original quantity on the line is 5,
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NOTENOTE

and a quantity of 3 is received. In this case, only two can be canceled. The line is then updated to ReceivedReceived

status.

If a delivery remainder is added to the order line, and it exceeds the quantity on the order line, the CancelCancel  action

doesn't cancel the excess quantity. Instead, the line remains in Open orderOpen order  status, because it has a remaining

quantity. For example, the original quantity on the line is 5, and the delivery remainder is 7. If the order is

canceled, five are canceled, and a quantity of 2 remains, as you can see in the inventory transactions.

To cancel the whole quantity on a PO line, you should cancel the delivery remainder quantity on the line. The line

will then be updated to CanceledCanceled status.

If a PO is under change management, any change, such as cancellation of the order or the delivery remainder,

must be submitted to the workflow system and approved before the process can be completed and the

inventory transactions can be updated as canceled.

Purchase order overview

Create purchase orders

Product receipt against purchase orders

Vendor invoices overview

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Purchase order approval mobile workspace
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Overview

Prerequisites

Prerequisites if you use Supply Chain ManagementPrerequisites if you use Supply Chain Management

Prerequisites if you use Microsoft Dynamics 365 for Operations version 1611 with Platform update 3 or laterPrerequisites if you use Microsoft Dynamics 365 for Operations version 1611 with Platform update 3 or later
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Implement KB 4017918. System administrator KB 4017918 is an X++ update or
metadata hotfix that contains the
Purchase order approvalPurchase order approval mobile
workspace. To implement KB 4017918,
your system administrator must follow
these steps.

Publish the Purchase orderPurchase order
approvalapproval mobile workspace.

System administrator See Publish a mobile workspace.

This topic provides information about the Purchase order approvalPurchase order approval  mobile workspace. This workspace lets

you view purchase orders and respond to them through actions. For example, you can approve or reject a

purchase order.

Purchase orders that requires approval go through an approval workflow. The workflow can include various

steps that require that one or more people take action. For example, a person might have to complete a task or

approve the purchase order.

The Purchase order approvalPurchase order approval  mobile workspace lets you easily view and respond to purchase orders from

your mobile device. This workspace also lets you take the same workflow actions that you can take from the

web client.

The prerequisites vary, depending on the version of Supply Chain Management that has been deployed for your

organization.

If Supply Chain Management has been deployed for your organization, the system administrator must publish

the Purchase order approvalPurchase order approval  mobile workspace. For instructions, see Publish a mobile workspace.

If Microsoft Dynamics 365 for Operations version 1611 with Platform update 3 or later has been deployed for

your organization, the system administrator must complete the following prerequisites.

1. Download the metadata hotfix
from Microsoft Dynamics
Lifecycle Services (LCS).

2. Install the metadata hotfix.

3. Create a deployable package
that contains the SCMMobileSCMMobile
model, and then upload the
deployable package to LCS.

4. Apply the deployable package.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/purchase-order-mobile-workspace.md
file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/publish-mobile-workspace.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/migration-upgrade/download-hotfix-lcs.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/migration-upgrade/install-metadata-hotfix-package.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/create-apply-deployable-package.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/apply-deployable-package-system.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/publish-mobile-workspace.html


Download and install the mobile app

Sign in to the mobile app

View orders that are assigned to you

Complete an action on the purchase order

Download and install the Finance and Operations mobile app:

For Android phones

For iPhones

1. Start the app on your mobile device.

2. Enter your Microsoft Dynamics 365 URL.

3. The first time that you sign in, you're prompted for your user name and password. Enter your credentials.

4. After you sign in, the available workspaces for your company are shown. Note that if your system

administrator publishes a new workspace later, you will have to refresh the list of mobile workspaces.

1. On your mobile device, select the Purchase order approvalPurchase order approval  workspace.

2. Select Orders assigned to meOrders assigned to me to view all the purchase orders for which you've been asked to take action in

the purchase order approval workflow.

3. Select an order. On the Order detailsOrder details  page, you will see the order header information and lines. You can also

find guidelines from the workflow task.

4. Select Accounting distr ibutionsAccounting distr ibutions  to open the Header accounting distr ibutionsHeader accounting distr ibutions  page.

5. Return to the Order detailsOrder details  page, and select a line. From the order line details, you can also explore the line-

specific accounting distributions.

After you've viewed the purchase order that is assigned to you and read the workflow instructions, you should

be ready to take action.

1. On your mobile device, select the Purchase order approvalPurchase order approval  workspace.

2. Select Orders assigned to meOrders assigned to me to view all the purchase orders for which you've been asked to take

https://go.microsoft.com/fwlink/?linkid=850662
https://go.microsoft.com/fwlink/?linkid=850663
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Complete Approve

Return Reject

Request change Request change

Delegate Delegate

action in the purchase order approval workflow.

3. Select an order, and view the details page.

4. Select ActionsActions  to show the available actions. The actions that are available depend on the task that has

been assigned to you.

5. Select the appropriate action.

6. On the Complete taskComplete task page, enter a comment. Note that if you select the DelegateDelegate action, you must

select a user to delegate the task to.

7. Select DoneDone. After you refresh your workspace, the purchase order will no longer be in your list.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Prepare a new purchase order for receipt of goods

Record receipt of goods

NOTENOTE

This topic explains how to record receipt of goods directly on a purchase order. It's also possible to register

product receipt in the warehouse, and then later record it on the purchase order. This task is typically done by a

purchasing agent or an accounts payable coordinator. The example shown in this guide can be used in the USMF

demo data company. The example includes steps to create a simple purchase order so that you can play the

procedure as a task guide. If you were using the procedure on your own data, you would start at the RecordRecord

receipt of goodsreceipt of goods  subtask.

1. Go to Navigation pane > Modules > Procurement and sourcing > Purchase orders > AllNavigation pane > Modules > Procurement and sourcing > Purchase orders > All

purchase orderspurchase orders .

2. Select NewNew .

3. In the Vendor accountVendor account field, enter US-101 .

4. Select OKOK.

5. In the Item numberItem number  field, enter M0001 .

6. In the QuantityQuantity  field, enter 5 .

7. On the Action Pane, select PurchasePurchase.

8. Select ConfirmConfirm .

1. On the Action Pane, select ReceiveReceive.

2. Select Product receiptProduct receipt. The QuantityQuantity  field allows you to select different options for the quantity that you

want to receive. For example, if a quantity has previously been registered in the warehouse, you can select

Registered quantityRegistered quantity . For this example, use the value Ordered quantityOrdered quantity .

3. Expand the Over viewOver view  section.

4. In the Product receiptProduct receipt field, type any value. This field is used to enter a reference that will be used as

voucher for the product receipt journal.

5. Expand the L inesLines  section.

6. Set QuantityQuantity  to '4'. Here you are able to manually specify the quantity that is being received for each line on

the order.

7. Select OKOK. The goods have now been recorded as received on the purchase order, and a product receipt

journal has been created as document to reflect this. You can use the Product receipt action to review the

journals created with the purchase order, and see what was received, and when.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/tasks/record-receipt-goods-purchase-order.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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An action can be completed only after the line number is fully
distributed.

When purchase orders are imported through data management,
purchase order line numbers don't follow the increment that defined
in system parameters.
Issue descriptionIssue description

Issue workaroundIssue workaround

A default tax group and a default cash discount aren't filled in from
the invoice account.

I receive an "Object reference not set" error during purchase order
confirmation, or an "Exception has been thrown by the target of an
invocation" exception occurs during vendor invoice posting.

This topic describes how to fix issues that you might encounter while you work with purchase orders.

This issue can occur because of inconsistency in purchase order distributions.

To unblock this issue and reset the purchase order to a Draft state, go to Procurement and sourcing >Procurement and sourcing >

Periodic tasks > Clean up > Purchase order distr ibution resetPeriodic tasks > Clean up > Purchase order distr ibution reset. For more information, see the following

blog post: Resolve PO distribution errors in Dynamics 365 Supply Chain Management.

By default, automatically generated line numbers for purchase order lines that are imported through the

Purchase order lines V2 data entity don't use the system line number increment that is specified in system

parameters. If you manually create a purchase order and add lines through the user interface (UI), the line

numbers are incremented correctly. However, if you use the Data management framework (DMF), they aren't

incremented correctly.

This issue occurs because, when you import lines via DMF, if line numbers aren't already assigned in the

imported entity, the system uses DMF's method for assigning them. That method always increments line

numbers by one.

Make sure that the desired line numbers are already given in the data entity line number fields when you import

the purchase order lines. In this case, DMF won't overwrite the line numbers.

If you're using an invoice account that differs from the customer account, a default tax group and a default cash

discount aren't filled in from the invoice account when a purchase order is created.

This behavior is by design. The default values for the tax group, cash discounts, and other price information are

based on the customer account, not the invoice account.

This issue can occur because of inconsistency in purchase order distributions.

To unblock this issue and reset the purchase order to a Draft state, go to Procurement and sourcing >Procurement and sourcing >

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/troubleshoot-purchaseorders.md
https://cloudblogs.microsoft.com/dynamics365/it/2020/08/12/resolve-po-distribution-errors-in-dynamics-365-supply-chain-management/


One or more accounting distributions are either over-distributed or
under-distributed.
Issue descriptionIssue description

Issue resolutionIssue resolution

Can I show only purchase orders that I created?

Can I reserve inventory and create transactions against registered
inventory on a purchase order?
Issue descriptionIssue description

Reproduce the issueReproduce the issue

Issue resolutionIssue resolution

Purchase orders don't reflect the language settings of the legal entity.
Issue descriptionIssue description

Reproduce the issueReproduce the issue

Periodic tasks > Clean up > Purchase order distr ibution resetPeriodic tasks > Clean up > Purchase order distr ibution reset. For more information, see the following

blog post: Resolve PO distribution errors in Dynamics 365 Supply Chain Management.

You receive the following error : "One or more accounting distributions is either over-distributed or under-

distributed."

This issue can occur because of inconsistency in purchase order distributions.

To unblock this issue and reset the purchase order to a Draft state, go to Procurement and sourcing >Procurement and sourcing >

Periodic tasks > Clean up > Purchase order distr ibution resetPeriodic tasks > Clean up > Purchase order distr ibution reset. For more information, see the following

blog post: Resolve PO distribution errors in Dynamics 365 Supply Chain Management.

This functionality isn't currently available.

Even when items are in a Registered state on a purchase order, you can still reserve the inventory. In other

words, you can create transactions against the registered inventory.

The following procedure shows one way to reproduce the issue.

1. Create a purchase order.

2. Register the purchase order line.

3. Notice that you can generate reservations or transactions against the registered inventory.

This behavior is by design. The expectation is that the registered items have physically arrived in the warehouse

or inventory, and that they are therefore available for reservation.

The product name on a purchase order is shown in the system language instead of the language that is set for

the legal entity where the purchase order was created.

The following procedure shows one way to reproduce the issue.

1. Set the system language to EN-US (US English).

2. Make sure that there is a product where the EN-US and DE (German) languages are maintained for

translations of the product name.

3. Change the language of a legal entity to DE.

4. In the legal entity where DE is set as the language, create a purchase order that includes the product.

https://cloudblogs.microsoft.com/dynamics365/it/2020/08/12/resolve-po-distribution-errors-in-dynamics-365-supply-chain-management/
https://cloudblogs.microsoft.com/dynamics365/it/2020/08/12/resolve-po-distribution-errors-in-dynamics-365-supply-chain-management/


Issue resolutionIssue resolution

The Approved vendor list by product entity doesn't allow the effective
date to be changed.
Issue descriptionIssue description

Issue resolutionIssue resolution

After I change the delivery address on a purchase order header, the
delivery name isn't synced.
Issue descriptionIssue description

Issue resolutionIssue resolution

Can I find the user who canceled a purchase order?

5. Notice that the product name is still shown in US English (the system language).

This behavior is by design. On purchase orders, the product is always shown in the system language. The

purchase order language is used when a confirmation journal is created.

A product has an approved vendor that has, for example, an effective date of January 11, 2018 (01/11/2018),

and an expiration date of Never. If you try to change the effective date to January 10, 2018 (01/10/2018), or

January 12, 2018 (01/12/2018), you receive the following error :

Cannot create a record in Approved supplier list (PdsApproveVendorList). The 'Expiration' value needs to be

greater than or equal to the 'Effective' value.

You can only extend the period that the vendor is approved for. The following rules apply:

To change the effective date so that it's earlier than any of the existing records (periods) for the item vendor,

the expiration date of the new period must be before all the expiration dates in the existing records.

To change the expiration date so that it's later than any of the existing periods, the effective date must be after

the latest expiration date in any existing record.

To reduce the overall period that the vendor is approved for, you must delete or modify existing records.

Alternatively, you can use the truncatetruncate switch during import. This switch deletes all existing records in the

table for approved vendors by item.

For the example scenario that is described in the issue description, where a record has an effective date of

01/11/2018 and an expiration date of Never, you can import a new record that has an effective date of

01/10/2018 and an expiration date of Never. However, you can't reduce the period so that the effective date is

updated to 01/12/2018 via data management. You must make this change through the UI.

The address on the header of a purchase order is updated to an address that isn't a delivery address. Although

the address is updated on the purchase order, the delivery name isn't updated based on the updated address.

This behavior is by design. The selected address must be classified as a delivery address. Otherwise, the delivery

name isn't updated based on the selected address.

This information is tracked only if the purchase order is subject to change management. If you use change

management, you can see who submitted the change (the cancellation), and who approved it.
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Creating a purchase order header

Adding purchase order lines

This article describes the process and options when you manually create a purchase order.

When you create a purchase order (PO), general information about the whole order is specified in the PO

header, and you then add one or more PO lines. This article describes some of the most frequently used options

that are available.

You can also create POs by copying lines from another PO document or a sales order. In this case, you can

reverse the sign on the inventory, as you would reverse the sign on an invoice to indicate credit.

Although you can manually create POs, they are more typically generated from other processes. Orders can be

automatically created based on other documents, such as requisitions. Alternatively, they can be created as part

of the master planning process through planned POs. If you use purchase agreements, POs can be created by

the Release orderRelease order  action. There are also more advanced methods for automatically creating a PO. For example,

orders can be created when you use direct delivery or intercompany order chains.

When you create a new PO, a dialog box appears, where you can enter the most common information for the

PO header. When you click OKOK to close the dialog box, the order is created, and you can then specify additional

information in the header.

The first detail that you must consider when you create a PO is the type of order. The Purchase orderPurchase order  type is

used most often. However, if a credit invoice is required, you can use the Returned orderReturned order  type.

You must specify the supplier in the Vendor accountVendor account field. For this field, you can search on either the account

or the vendor name. If a vendor delivers from multiple locations but uses a single invoice account, you can select

that invoice account in the Invoice accountInvoice account field and then use it with different vendor accounts. If you must

create a PO for products that won’t be ordered repeatedly, you can use the One-time supplierOne-time supplier  option. This

option automatically creates a new vendor account that is marked as a one-time account, to support a later

clean-up process for one-time accounts in the Accounts payableAccounts payable module. When you select a vendor account,

many fields in the PO header inherit default values from the information that is associated with the vendor

account. For example, the default delivery site and warehouse are copied from the vendor information. However,

you can override these default values if the purchase is intended for another location.

If the supplier has provided a reference number for the order, you can record this information in the VendorVendor

referencereference field. For returned orders, you must specify a value in the RMARMA field to reference the supplier ’s

authorization for processing the return.

If a purchase agreement is associated with the order, you must specify this information in the PurchasePurchase

agreementagreement field.

The PO header also contains information about charges that apply to the whole order instead of individual lines.

Charges can be automatically added to the order if automatic charges have been set up for the vendor or the

vendor’s charge group. You can also manually add charges to the order header by clicking Maintain chargesMaintain charges

on the Action Pane.

POs can be for physical products or for services. A setting on the inventory model group determines whether a
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particular item number applies to a product or a service. Usually, the item that is purchased is specified by an

item number. However, if the order is for products or services that are directly consumed, you can also specify

the item by using a procurement category.

PO lines contain lots of fields, but many of these fields have a default value or a value that is inherited from the

order header. Additional fields are set when you select a product or service. The fields that are most often set

manually include the fields for the item number, quantity, and requested delivery date. Information about unit

price and discounts is also very important, but the values of those fields are often determined by trade

agreements or purchase agreements.

When you select a product, you can search on all or part of the product name instead of using the item number.

If the product has several variants, such as different sizes, you can see an overview of the available variants by

using the Add linesAdd lines  function or by using the lookup that is available in the Variant numberVariant number  field.

Often, you will have to specify several dimensions for the item that is selected on each PO line. The dimensions

that must be specified depend on the dimension groups that have been assigned to the product master

definition. For example, you will often have to specify a site and warehouse to indicate the location that the

product should be delivered to. You identify product variants by specifying a variant number, or by entering

values for one or more product dimensions, such as color, size, configuration, or style. Tracking dimensions, such

as batch and serial number, let you uniquely identify each inventory lot. After you’ve created an order, you can

capture dimension values on the order by using the RegistrationRegistration action. For example, you have ordered a

quantity of five pieces of an item. Later, you register that three of those pieces will be black, and two of them will

be blue. This approach is an alternative to capturing the dimension information during arrival registration.

You can check the details of the inventory transaction status for stocked products. For example, you might want

to check the on-hand inventory to help you decide how much to order. Alternatively, you might want to review

the inventory status of an ordered quantity to see whether inbound arrival registration has occurred.

A PO line that is being used to return a product to the vendor will have a negative quantity. You can select a

specific lot to return by using the Reser vationReser vation action.

Sometimes, you might want to divide the quantity that you’ve ordered, so that different parts of it are delivered

on different dates. You can set up these deliveries by using the Deliver y scheduleDeliver y schedule action, which is available on

the Purchase order linePurchase order line menu in the L inesLines  view.

Charges can be automatically added to PO lines, if automatic charges have been set up for the vendor or vendor

charge group, and for the item or item charge group. However, more typically, charges are added manually at

the order line level. To add a charge, open the Maintain chargesMaintain charges  page by using the Maintain chargesMaintain charges  action

on the FinancialsFinancials  menu in the L inesLines  view. The advantage of adding charges directly at the order line level is

that the charge can be allocated as an inventory cost. To set up charge codes to account product cost, use the

ItemItem debit option. These types of charges must be allocated from the PO header to the lines before the order

can be confirmed. For example, you might want to allocate charges based on the quantity on each line. The

charge category also affects how charges are accounted. For example, fixed charges specify a fixed amount, and

percent charges are calculated as a percentage of the net amount for the order line. POs can be assigned to a

load, and the load might include an estimate of the expected expense for the transportation cost. You can

allocate this expense from the load back to the PO lines.

After you’ve added the header and lines to the PO, you must often complete additional steps before the order is

ready to be confirmed. Because so many options are available, you might find it helpful to use Action search to

find the relevant menu item.

You can configure products on the order so that they have supplementary items. Supplementary items are

products that must or can be bought together with other products. Supplementary products might be added

free of charge as accompanying products, or you may be able to decide whether to add them to the order or
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not. You can review the supplementary items after each order line that is added. However, you will probably find

it more convenient to review and add relevant supplementary items for all the order lines by using the

Supplementar y itemsSupplementar y items page, which you can open from the Action Pane.

Discounts are usually added to lines as they are created. However, a few discounts apply to the whole order :

The Total discountTotal discount action calculates a total discount percentage that is applied to the full order. Don’t

confuse this discount with the cash discount percentage. Cash discounts are applied when the invoice is paid,

and they depend on payment settlement by a specific date.

If a multi-line discount applies, you must use the Multiline discountMultiline discount action to calculate and assign it to the

order. Multi-line discounts are discounts that can be offered if a mix of products on the order exceeds a joint

threshold. Only a few companies use this type of discount.

Charges that have a charge code that uses the ItemItem debit type must be assigned to the line level before the

order can be confirmed. You might find it convenient to assign these charges at the order header level, so that

you can specify the total amount of the charge. However, in this case, the charge must then be allocated down to

each line before the order can be confirmed. You can use the Allocate chargesAllocate charges  action to split amounts from

charges that are assigned at the header level down to the order lines. Charges can be split according to the net

amount of each line, according to the quantity that has been ordered, or evenly across the order lines. After

you’ve allocated charges to the lines, the charge is removed from the order header.

POs can be configured to require that budget funds be allocated to the order before it can be processed. In this

case, you can use the Budget checkingBudget checking action to allocate the budget.

You might have to delay the completion of a PO. For example, you might require additional information about

products or services, or you might have to get authorization for the spend. There are several ways to hold back

an order. For example, you can wait to confirm the order. Alternatively, if a change management workflow is

being used, don’t submit the order for approval. If you must block all orders for a particular vendor, you can also

mark the vendor as On holdOn hold for processing on the vendor master. There are also circumstances that might

prevent the order from being processed. For example, processing might be prevented if credit limits have been

exceeded, or if required budget funds aren’t available.

Purchase order overview

Approve and confirm purchase orders

Product receipt against purchase orders

Vendor invoices overview

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Create the purchase order header

Add a purchase order line

This topic shows you how to create a purchase order manually. It's more typical for purchase orders to be

created automatically as result of master planning, direct delivery, and other processes. Purchase orders are

typically created by a purchasing agent. The example shown here can be used in the USMF demo data company

using the values that are suggested in the notes for various steps.

1. Go to Navigation pane > Modules > Procurement and sourcing > Purchase orders > AllNavigation pane > Modules > Procurement and sourcing > Purchase orders > All

purchase orderspurchase orders .

2. Select NewNew .

3. Select vendor account US-101US-101 . When you select a vendor, details from the vendor record such as

address, invoice account, delivery terms, and delivery mode will be copied as default values into the

order header. You can change these values at any time.

4. Expand the GeneralGeneral  section.

The S iteSite field together with the WarehouseWarehouse field specifies where the procured goods or services

must be delivered to. The default delivery address is the site. Both fields can be populated with values

set up for the selected vendor, or you can specify them manually.

The Deliver y dateDeliver y date field is used to specify when procured goods and services need to be delivered.

You can specify a single delivery date for the order, or the individual order lines can be given unique

delivery dates. If the delivery date specified here cannot be met for specific products or services

because they have longer lead times, then those lines will be created with a later delivery date to

accommodate for this.

5. Expand the AdministrationAdministration section. The OrdererOrderer  field can be used to specify who is placing the order.

This may be convenient to share with the vendor in case they need to contact that person. The field may

be assigned a value automatically if the current user account is associated with a name on the UsersUsers

page.

6. Select OKOK. The order header has now been created. When you work with purchase order lines, only a

summary of the header information is shown. If you need to view the rest of the information, select

HeaderHeader .

1. Select Purchase order linePurchase order line.

2. Select DimensionsDimensions . Products can be in variants that are differentiated by dimensions, such as color, size,

or style. Products can also be set up to use storage dimensions, such as site and warehouse. There are

also optional tracking dimensions, such as batch and serial numbers. To improve the efficiency of order

entry, you can add the dimension fields that you commonly use directly to the order grid.

3. Select the ColorColor  check box. Optional: If you select the Save setupSave setup field, the dimensions you have chosen

will also be shown on the order line grid the next time you open the purchase order page.

4. Select OKOK.
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5. In the Item numberItem number  field, select T0004T0004 .

Order lines are created for products and services by specifying an item number, or as expenses by

specifying a procurement category.

The ProcurementProcurement category field is used for adding lines where procured items are expensed directly,

rather than going into inventory. This means that if you need to expense a purchase you can do this by

creating a purchase order line that specifies a procurement category, rather than creating a line with

an item number. Items can also be associated with a procurement category and in this case, the

procurement category is shown as informational only.

6. In the ColorColor  field, enter or select a value. The S iteSite and WarehouseWarehouse fields are typically populated with

values from the order header, but it is possible to override the fields if some lines need to be delivered to

different locations.

7. In the QuantityQuantity  field, enter a number.

Select the quantity that you want to purchase. The QuantityQuantity  field is automatically populated with the

minimum order quantity for the product if this is set up, or with the value of 1.

The UnitUnit field indicates the unit of measure for the ordered quantity. Typically, the unit is automatically

provided from the purchasing unit on the product master data, but you can change this.

The Unit pr iceUnit pr ice field typically contains a value from either a purchase agreement or a trade

agreement. It's possible to change the unit price on individual order lines, for example if a unique price

is negotiated with the vendor.

The DiscountDiscount field represents a discount amount per unit. This discount therefore reduces the unit

price by the discount. This discount is commonly supplied automatically from purchase agreements or

trade agreements, but it is possible to override on individual lines if unique discounts have been

negotiated with the vendor.

A discount percentage can be entered that reduces the net amount for the line accordingly. The

discount percent is often supplied automatically from purchase agreements or trade agreements, but

it is possible to override on individual lines if a unique discount percentage has been negotiated with

the vendor.

The value in the Net AmountNet Amount field is calculated from other fields on the line including quantity, unit

price, discount, and discount percent. It's possible to change the Net amount, but then the Unit Pr iceUnit Pr ice,

DiscountDiscount, and Discount percentDiscount percent fields will be blank and when you post toward the line, the amount

posted will be proportional to the net amount. Typically the Net AmountNet Amount field is only used for

displaying the net amount of the line.

8. Expand the L ine detailsL ine details  section.

9. Select the Deliver yDeliver y  tab. A unique delivery date can be assigned to each order line. The date is inherited

from the field on the purchase order header, but you can change this.

1. Select TotalsTotals .

If you don't see the TotalsTotals  action, select the Purchase OrderPurchase Order  tab on the Action Pane.

This dialog box shows totals for the whole order.

The SelectionSelection field allows you to change the basis of how totals are calculated. For example, you

could choose Product receipt quantityProduct receipt quantity  to show totals that relate to the amount of the product(s)

that have been received, or Ordered quantityOrdered quantity  to show the amount of product that was ordered.

2. Select OKOK.



NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a delivery schedule

This topic demonstrates how to create a delivery schedule for a purchase order. A delivery schedule is used

when a quantity on an order or a journal is requested to be delivered in multiple shipments. The example shown

in this guide can be used in the USMF demo data company. This procedure would typically be done by a

purchasing agent.

1. In the navigation pane, go to Modules > Procurement and sourcing > Purchase orders > AllModules > Procurement and sourcing > Purchase orders > All

purchase orderspurchase orders .

2. On the Action Pane, select NewNew .

3. In the Vendor accountVendor account field, enter US-101 .

4. Select OKOK.

5. In the Item numberItem number  field, enter M0001 .

6. In the QuantityQuantity  field, enter 10 .

7. Select Purchase order linePurchase order line.

8. Select Deliver y scheduleDeliver y schedule.

The Deliver y scheduleDeliver y schedule page allows you to specify the number of shipments in which the total quantity of

the order line will be delivered from the vendor.

By default, the system copies the total quantity and other delivery details of the original purchase line into

the first delivery schedule line. In this example, we'll create a schedule for two shipments, with the second

shipment's date offset by a week from the first shipment.

9. In the QuantityQuantity  field, change the quantity to 4 .

10. Select NewNew .

11. In the QuantityQuantity  field, enter 6  as the remaining quantity.

In the delivery date field, select a date that's one week after the date on the first delivery line.

You can keep track of the total quantity that's allocated to the delivery schedule lines by looking at the TotalTotal

and RemainingRemaining fields. When the remaining quantity is zero, the full quantity from the original line has been

allocated to the schedule.

12. Expand the Charges conversionCharges conversion section.

The options here allow you to control how you want charges to be distributed across the delivery schedule

lines. If you select Copy gross amountsCopy gross amounts , the charge amount on the original order line is copied to each

delivery line. The Allocate to deliver y linesAllocate to deliver y lines  option divides the original line charge according to the

quantity on each delivery line.

13. Collapse the Charges conversionCharges conversion section.

14. Select OKOK.

The delivery schedule has now been applied to the order.

The original order line, now referred to as a Commercial line, has been converted to an Order line with

multiple deliveries. It is marked with a distinct icon and acts as a header for the delivery lines.

15. Select the second order line, which is the first of the two delivery lines.
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The two new lines, referred to as Delivery lines, make up one delivery schedule. The order will be processed

against these lines and not the original line. If documents such as confirmations, product receipt journals, or

invoices are printed, only the delivery lines are shown.

You can change the quantity on delivery lines. If you do this, the commercial line is automatically updated to the

total quantity in the delivery lines.

1. In the QuantityQuantity  field of the first delivery line, change the quantity from 4  to 5 .

2. Select the first order line (the commercial line).

The quantity on the commercial line has been changed to 11.

The purchase order must be confirmed before the product receipt can be processed. In this example, receipt is

recorded directly on the purchase order. The receipt could also have been recorded when the goods arrived in

the warehouse.

1. On the Action Pane, select PurchasePurchase.

2. Select ConfirmConfirm .

3. On the Action Pane, select ReceiveReceive.

4. Select Product receiptProduct receipt. In the Product receiptProduct receipt field, type any value.

This field is used to enter a reference that will be used as voucher for the product receipt journal.

In the QuantityQuantity  field, select Ordered quantityOrdered quantity . This option means that the receipt will process for the

quantity that the order lines were created with.

Make sure that the Pr int product receiptPr int product receipt field is set to NoNo. Printing isn't needed in this example.

5. Expand the L inesLines  section.

Notice how the product receipt is created for the two delivery lines and not the original order line. If the

receipt had been recorded in the warehouse, it would also have been recorded on the delivery schedule lines.

6. Collapse the L inesLines  section.

7. Select OKOK to post the receipt.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a purchase order for a one-time supplier

NOTENOTE

This procedure shows you how to create a purchase order for a one-time supplier. The supplier is created

automatically with the purchase order, rather than having to create the vendor account manually. Purchase

orders are typically created by a purchasing agent. The example shown in this guide can be used in the USMF

demo data company. It is a prerequisite that a one-time vendor account has been set up in the Account payable

parameters page.

1. Go to Procurement and sourcing > Purchase orders > All purchase orders.

2. Click New.

3. Select Yes in the One-time supplier field.

4. In the Name field, type a name for the supplier.

5. Click OK.

A vendor account is automatically created and assigned to the purchase order. The vendor account is

created based on the template that is specified on the General tab in the Accounts payable parameters

page.

The purchase order can now be completed and processed like any other order. There are no special

characteristics related to how this is done. The invoice will account a due transaction on the vendor

account that was created with the order, and payment will then be processed.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a purchase order

Add a line

Look up the commitment

This procedure shows how to use a purchase agreement when you create a purchase order. The purchase

agreement has to be applied when you create the purchase order because there are general terms that should

be copied to the purchase order header. Typically this task would be carried out by a purchasing agent. As a

prerequisite for this guide, you must have an effective purchase agreement with a product quantity commitment

for a vendor and items. The same procedure can be used if you have a purchase agreement with other types of

commitments. You can run this guide in demo data company USMF. If you're using USMF, you can run the

"Create a purchase agreement" guide first to set up the necessary preconditions for this guide.

1. Open the purchase order preparation workspace.

2. Click New purchase order.

3. In the Vendor account field, click the drop-down button to open the lookup.

4. In the list, find and select the desired record.

5. In the list, click the link in the selected row.

6. Toggle the expansion of the General section.

7. In the Purchase agreement field, click the drop-down button to open the lookup.

8. In the list, click the link in the selected row.

9. Click Yes.

10. Click OK.

All available agreements for the vendor are listed here. Find the effective agreement that you want to

use.

1. In the Item number field, type a value.

2. In the Site field, click the drop-down button to open the lookup.

3. In the list, find and select the desired record.

4. In the list, click the link in the selected row.

5. In the Quantity field, enter a number.

If there are specific inventory or location dimensions on the commitment you must enter the same

values on the purchase order line to make use of the agreement.

The site may already be populated with the default value from the order, or from the vendor. If this is

the case, skip this step.

Validate that the price is copied from the commitment.

1. Click Update line.

2. Click Attached.

Here you can get details for the purchase agreement. For example, you can see the price and whether

the price and discount are fixed, which means that if you change price or discount on the purchase
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3. Close the page.

order to a different value than on the commitment, the system will remove the link so the purchase

order line does not fulfill the commitment. You can also see if the Max is enforced option is selected,

which means that the quantity on the commitment cannot be exceeded by summing all of the

purchases that fulfill the commitment.

1. On the Action Pane, click General.

2. Click Purchase agreement.

3. Close the page.

4. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a purchase order

Add a line

Look up the commitment

This procedure shows how to use a purchase agreement when you create a purchase order. The purchase

agreement has to be applied when you create the purchase order because there are general terms that should

be copied to the purchase order header. Typically this task would be carried out by a purchasing agent. As a

prerequisite for this guide, you must have an effective purchase agreement with a product quantity commitment

for a vendor and items. The same procedure can be used if you have a purchase agreement with other types of

commitments. You can run this guide in demo data company USMF. If you're using USMF, you can run the

"Create a purchase agreement" guide first to set up the necessary preconditions for this guide.

1. In the Navigation paneNavigation pane, go to Workspaces > Purchase order preparationWorkspaces > Purchase order preparation.

2. Click New purchase orderNew purchase order .

3. In the Vendor accountVendor account field, click the drop-down button to open the lookup.

4. In the list, find and select the desired record.

5. In the list, click the link in the selected row.

6. Expand the GeneralGeneral  fastTab.

7. In the Purchase agreementPurchase agreement field, click the drop-down button to open the lookup. All available agreements

for the vendor are listed here. Find the effective agreement that you want to use.

8. In the list, click the link in the selected row.

9. Click YesYes .

10. Click OKOK.

1. In the Item numberItem number  field, type a value. If there are specific inventory or location dimensions on the

commitment you must enter the same values on the purchase order line to make use of the agreement.

2. In the S iteSite field, click the drop-down button to open the lookup. The site may already be populated with the

default value from the order, or from the vendor. If this is the case, skip this step.

3. In the list, find and select the desired record.

4. In the list, click the link in the selected row.

5. In the QuantityQuantity  field, enter a number. Validate that the price is copied from the commitment.

1. Click Update lineUpdate line.

2. Click AttachedAttached. Here you can get details for the purchase agreement. For example, you can see the price and

whether the price and discount are fixed, which means that if you change price or discount on the purchase

order to a different value than on the commitment, the system will remove the link so the purchase order

line does not fulfill the commitment. You can also see if the Max is enforced option is selected, which means

that the quantity on the commitment cannot be exceeded by summing all of the purchases that fulfill the

commitment.

3. Close the page.
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1. On the Action PaneAction Pane, click GeneralGeneral .

2. Click Purchase agreementPurchase agreement.

3. Close the page.

4. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a new purchase return order

This procedure shows you how to create a purchase return order by using the Credit note action to copy lines

from a vendor invoice document to a new PO. It also shows you how to confirm the order and process shipment

of the goods back to the vendor. The example shown in this procedure can be used in the USMF demo data

company. This task would typically be carried out by a purchasing agent.

1. Go to Navigation pane > Modules > Procurement and sourcing > Purchase orders > AllNavigation pane > Modules > Procurement and sourcing > Purchase orders > All

purchase orderspurchase orders . The first step is to create a new purchase order to be used as the purchase return

order.

2. Click NewNew .

3. In the Vendor accountVendor account field, enter "US-102".

4. Click OKOK.

5. On the Action PaneAction Pane, click PurchasePurchase.

6. Click Credit noteCredit note. This is the page from which you can copy from an existing vendor invoice to your

return order. This is the same page that's used for other copy actions. But because we've opened it from

the Credit note action, the page is configured to support the creation of a return order that offsets vendor

invoices.

7. Expand the ParametersParameters  section.

The Inver t signInver t sign option is automatically selected, and cannot be changed. This ensures that the sign is

changed for the quantities, and that order lines that are added will offset the vendor invoice.

The Copy chargesCopy charges  option is automatically selected, and cannot be changed. This means that charges

from the vendor invoice are added to the purchase return order to offset the original charge. It's

possible to modify the changes on the order header and lines later.

The Copy preciselyCopy precisely  option is automatically selected, and cannot be changed. This ensures that an

exact copy is made of the values in all the fields on the vendor invoice header and lines. This means

that a purchase return order is created with values that match all terms used with the vendor invoice

document.

The Delete purchase linesDelete purchase lines  option deletes any purchase order lines that already exist on the

purchase order before adding the new lines. In this example we have not yet added any lines to the

purchase return order, so there wouldn't be any effect. Use this option with caution, as it deletes all

existing lines without further warning.

The Copy order headerCopy order header  option is automatically selected, and cannot be changed. This ensures that

information is copied from the vendor invoice and applied to the purchase return order header. This is

useful because it helps to ensure that the purchase return order offsets the invoice by using similar

terms.

8. Collapse the ParametersParameters  section.

9. Expand the InvoicesInvoices  section. The page has been opened from the Credit note action, so the only option

available is to copy information from vendor invoices. This tab shows all the available invoices for the

vendor account that's specified on the purchase return order that you created earlier. The invoices are
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identified by the invoice voucher or the purchase order IDs.

10. Locate the vendor invoice identified by invoice number AP-0006, and highlight that line by clicking on

any field in that line.

11. Select the line by clicking in the check box for the line. Notice that the lines available on the vendor

invoice are automatically selected together with the order. This particular vendor invoice has 2 order

lines. For this example, we'll return part of the quantity from the second line.

12. Highlight the second line (the one with item M0006) by clicking on any field in that line.

13. In the QuantityQuantity  field, change the quantity to 10. This is the quantity that we'll return to the vendor.

14. Highlight the first line (the one with item M0005) by clicking on any field in that line.

15. Clear the check box for the line. Only the lines that you've selected will be copied to your order.

16. Collapse the InvoicesInvoices  section.

17. Expand the Selected lines or header to be copiedSelected lines or header to be copied section. This view shows a summary of all the

documents and lines that you've selected to be copied to your order.

18. Collapse the Selected lines or header to be copied sectionSelected lines or header to be copied section.

19. Click OKOK. The line that you selected has now been copied to your purchase return order. The QuantityQuantity

field shows -10.

20. In the Purchase order linePurchase order line section, click Inventor yInventor y .

21. Click MarkingMarking. The order line that was created is marked against the inventory transaction from the

vendor invoice. This ensures that the inventory that's returned to the vendor is the same as the inventory

that was received from them earlier. There are some situations where marking does not occur, for

example, if the inventory has already been marked as Consumed, or if the product is one that doesn't use

marking.

22. Click OKOK.

1. Click Actions > ConfirmActions > Confirm .

2. On the Action PaneAction Pane, click ReceiveReceive.

3. Click Product receiptProduct receipt.

4. In the Product receiptProduct receipt field, type a value. This field is used to enter a reference that will be used as a

voucher for the product receipt journal.

5. Click OKOK. The goods have now been recorded as shipped on the purchase return order, and a product receipt

journal has been created. You can use the Product receipt action to review the journals created with the

purchase order, and see what was received or returned, and when.

This page is used to record product receipt for purchase orders and also to process the return of

goods back to the vendor. Order lines with a negative quantity mean that goods are to be returned to

the vendor, and the document that can be generated from this page can be used as packing slip for

this use.

In the QuantityQuantity  field, select Ordered quantity for this example. This ensures that the shipment will be

processed for the full ordered quantity that the order lines were created with.



NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create project purchase order
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NOTENOTE

This procedure shows you how to create a project purchase order. This task uses the USSI data set.

1. Go to Project management and accounting > Projects > All projects.

2. In the list, click the link in the selected row.

3. On the Action Pane, click Manage.

4. Click Item task.

5. Click Purchase order.

6. In the Vendor account field, enter or select a value.

7. In the Site field, enter or select a value.

8. In the Warehouse field, enter or select a value.

9. Click OK.

10. In the list, mark the selected row.

11. In the Item number field, enter or select a value.

12. Expand the Line details section.

13. Click the Project tab.

14. Click Save.

These steps aren't required, but they do simplify the purchase order by setting up a default site and

warehouse for the purchase order lines.

This can be the item number or a procurement category.

Verify that the sales and cost prices are available. If they are not available but needed, enter the

information.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/tasks/create-project-purchase-order.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a repeat purchase order
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Create a new repeat purchase order

This topic shows you how to create a repeat purchase order (PO) by copying lines from an earlier purchase

order document to a new PO or to an existing PO. There are two methods for creating repeat orders. You can use

the actions available at the document level from the Action Pane, or you can use the line detail actions. The

document level actions are mainly intended for creating a new purchase order by adding lines and header

information from another order, while the line details action is mainly for adding lines to an existing order. The

example shown in this guide can be used in the USMF demo data company. This task would typically be carried

out by a purchasing agent.

1. In the navigation pane, go to Modules > Procurement and sourcing > Purchase orders > AllModules > Procurement and sourcing > Purchase orders > All

purchase orderspurchase orders . First we'll try the option for copying information to a new order.

2. Select NewNew .

3. In the Vendor accountVendor account field, enter US-101 .

4. Select OKOK.

5. On the Action Pane, select Purchase orderPurchase order .

6. Select From allFrom all . This is the page from which you can copy from existing orders to your order. There are

different options for how the lines are copied, and different kinds of documents that you can copy from.

We'll look at the options for how lines are copied first.

7. Expand the ParametersParameters  section.

The Quantity factorQuantity factor  field is useful if you need to use a quantity that is different than the one that's on

the order that you're copying from. For instance, if you want to order twice the quantity that's in the

lines that you're copying from, you'd type '2' in this field and then the system will add lines where the

original quantity has been doubled.

The Inver t signInver t sign field also supports changing the ordered quantity by changing the sign of the

quantity for order lines that are added. This may be useful if you need to reverse a transaction, by

creating order lines that negate the transaction. This option is automatically selected when the page is

opened from the Create credit noteCreate credit note action.

The Copy chargesCopy charges  option allows you to copy charges to your new order from the document that

you're copying the order lines from.

The Recalculate pr icesRecalculate pr ices  option uses the current prices and discounts rather than copying these from

the document that you're copying other information from.

The Copy preciselyCopy precisely  option creates an exact copy of the values in all the fields on the order document

header and lines. If this option is not selected, default values are used for many of the fields relating to

the vendor and products just as if you were creating the new order manually. For example, if the order

that you're copying from had overridden the default Invoice account for the vendor, that same Invoice

account would be copied to your order. If you didn't select the Copy preciselyCopy precisely  option, the default

Invoice account for the vendor would be used on your order instead.

The Delete purchase linesDelete purchase lines  option deletes all purchase order lines that already exist on the purchase

order that you're copying to, before applying the new lines. Use this option with caution, as it deletes

all existing lines without further warning.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/tasks/create-repeat-purchase-order.md


Copy lines to an existing purchase order

NOTENOTE

If you use the Copy order headerCopy order header  option, you don't need to manually create the header information

on your new order. Note that this option will result in default values being used for the fields

associated with the vendor. If the document that you're copying from has non-default values that you

want to copy, use the Copy preciselyCopy precisely  option as well.

There are different document sources that you can copy from, and each has a separate section on this

page. For example, the Purchase ordersPurchase orders  section allows you to copy from existing purchase orders.

8. In the Purchase ordersPurchase orders  section, select the lines you'd like to be copied to your clipboard. It's possible to

select additional purchase orders lines from other purchase orders and copy them to your order as well.

It's also possible to add lines from other kinds of purchase documents. The next few steps review the

different options.

9. Expand the ConfirmationConfirmation section. Here you can select purchase order confirmations to copy from. The

purchase order confirmations are identified by the associated purchase journal ID or the purchase order

ID.

10. Expand the Product receiptsProduct receipts  section. Here you can select product receipt journals to copy from. The

product receipt journals are identified by the product receipt voucher or the purchase order ID.

11. Expand the InvoicesInvoices  section. Here you can select vendor invoices to copy from. The invoices are

identified by the invoice voucher or the purchase order ID.

12. Expand the Selected lines or header to be copiedSelected lines or header to be copied section. This view shows a summary of all

documents and lines that have been selected to be copied to your order.

13. Select OKOK. The lines that you selected have been copied to your new purchase order.

Instead of copying an entire order, it's more common to create a new PO and complete information on the PO

header, and then copy individual lines from existing orders.

1. Select Purchase orderPurchase order  line.

2. Select From allFrom all . The page that opens is identical to the one shown before, but different options are

selected when it's opened from the order lines view. Let's review the parameters.

3. Expand the ParametersParameters  section.

The Delete purchase linesDelete purchase lines  option is not selected. This means that you can copy new lines to your

order without removing existing lines.

The Copy order headerCopy order header  option is also not selected, as we're only adding additional lines to the order.

For this example, we'll copy lines from an existing purchase order.

4. Select the line for the desired purchase order. Notice that the single order line that's on this PO is also

selected.

5. Select OKOK. The additional order line has been added to your purchase order.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a requisition for consumption
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Create a new requisition

Add a line to the requisition

Add more products to the requisition

This topic describes the process of creating a requisition. It shows you different ways to search for products in

your procurement catalog and how to add a product that isn't in your catalog. Before you start this procedure,

you must have a purchasing policy set up with Consumption as the default type of requisition. You can walk

through this procedure in demo data company USMF, or using your own data. The procedure can only be

carried out by a user profile that is set up as worker. This task would normally be carried out by an employee.

The EmployeeEmployee employ security role will allow you to carry out the tasks, or if you're using USMF, you can log in

as AliciaAlicia .

1. Go to Navigation pane > Modules > Procurement and sourcing > Purchase requisitions >Navigation pane > Modules > Procurement and sourcing > Purchase requisitions >

Purchase requisitions prepared by mePurchase requisitions prepared by me.

2. Select NewNew .

3. In the NameName field, give the requisition a name.

4. In the Requested dateRequested date field, enter a date. By default, the requested date and accounting date are copied to

the purchase requisition lines. They can be changed at the line level. The requested date is the requested

delivery date.

5. In the Accounting dateAccounting date field, enter a date. The accounting date is used to record the accounting entry in the

general ledger, and to validate whether budget funds are available.

6. Select OKOK.

7. In the ReasonReason field, select an option from the drop-down menu. By default, the business justification reason

that you select appears for the purchase requisition lines, but you can change it at the line level.

8. Select the reason.

9. In the detailsdetails  field enter a more descriptive justification for the requisition.

1. Select Add lineAdd line. There are two ways of adding lines to the purchase requisition. If you already know the

product number or you already know that you are requesting a product that is not in the product catalog,

then you can add the line directly with Add lineAdd line. The other way is to use Add productsAdd products  where you can use

searching and filtering to find items in the product catalog.

2. Select the row you just created.

3. In the Item numberItem number  field, type a value. The items that are available for you to choose are limited by the

category access policy and the procurement catalog for the buying legal entity.

4. In the QuantityQuantity  field, enter a number.

The requester is the worker that has requested the requisition.

By default the person preparing the requisition is the worker who has requested it. You have to be

given permission to prepare a requisition line on behalf of another worker. If you have such

permissions then the other workers will show up in this lookup.

1. Select Add productsAdd products . This is the option where you can search for products in the product catalog.

2. In the Find procurement categor y nodeFind procurement categor y node field, enter the first part of the name of the category that you are

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/tasks/create-requisition-consumption.md


Distribute amounts

View line details

Submit the requisition

looking for, and then select EnterEnter . For example, enter comput .

3. Use the InvokeDefaultButtonInvokeDefaultButton shortcut.

4. Use the FilterFilter  to filter the list of products in the selected category.

5. Select the product card that you want to add to the requisition.

6. Select Add to linesAdd to lines .

7. In the QuantityQuantity  field, enter a number.

8. In the Find procurement categor y nodeFind procurement categor y node field, type the first part of the name of the category that you are

looking for, and then select EnterEnter . For example, enter High  (highlighters).

9. Use the InvokeDefaultButtonInvokeDefaultButton shortcut.

10. Select Add unlisted product to linesAdd unlisted product to lines  to add a product that's not listed in the procurement catalog.

11. In the Product nameProduct name field, type a value.

12. In the UnitUnit field, type a value.

13. Select OKOK.

14. In the Item descr iptionItem descr iption field, add a description of the product.

15. In the QuantityQuantity  field, enter a number.

16. In the Unit pr iceUnit pr ice field, enter a number. If you know the price for a particular vendor (that you select in the

vendor account field) then that price can be entered.

17. In the Vendor accountVendor account field, open the drop-down list to select an option. The vendors that are available in

this field depend on the purchasing policies and the status that the vendor has for the current procurement

category. As an alternative to selecting a vendor here, you can select Suggest vendorSuggest vendor .

18. In the list, select the vendor you want to use.

19. In the External item numberExternal item number  field, type a value. This is a reference number for the product that is known by

the vendor. For example, this could be the item number of the product in the vendor's own catalog.

20. Select OKOK.

1. Select FinancialsFinancials .

2. Select Distr ibute amountsDistr ibute amounts . This process shows you how to distribute the cost for the first line between 2

accounts. This can also be done later when the requisition is in review.

3. Select SplitSplit to create a new distribution line.

4. In the Ledger accountLedger account field select the first cost center that should take part of the cost.

5. Select the other distribution line.

6. In the Ledger account field specify the other cost center.

7. Select Distr ibute equallyDistr ibute equally .

8. Close the page.

1. Toggle the expansion of the L ine detailsL ine details  section.

1. Select WorkflowWorkflow  to open the drop dialog.

2. Select SubmitSubmit.

3. Close the page.

4. In the CommentComment field, type a note for the approver of the requisition.

5. Select SubmitSubmit.

6. Close the page.



NOTENOTE

7. Refresh the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Responsible workers on purchase agreements

IMPORTANTIMPORTANT

Commitment types

This article provides information about purchase agreements. A purchase agreement is a contract that commits

an organization to buy a specified quantity or amount by using multiple purchase orders over time. In exchange

for this commitment, the buyer receives special prices and discounts.

Purchase agreements can apply to a specific quantity of a product, a specific currency amount of a product, or a

specific currency amount of the products in a procurement category. The prices and discounts of the purchase

agreement override the prices and discounts that are specified in any trade agreements that exist.

On the Purchase agreementsPurchase agreements  page, you can create, apply, and follow up on purchase agreements that exist

between your organization and your vendors. For example, after you create a purchase agreement, you can

order directly from it. Each purchase agreement has a validity period that is defined by the person who creates

the purchase agreement. The delivery date of a purchase must be within the effective dates of this validity

period.

After you create a purchase agreement, you must activate it before it becomes effective. To activate a purchase

agreement, set the Mark agreement as effectiveMark agreement as effective option to YesYes .

To prevent your purchase agreement from being used and confirmed, mark the agreement status as ClosedClosed.

You can still update the status to EffectiveEffective any time after making this change.

You can identify a primary responsible worker and secondary responsible worker on the purchase agreement

classification. These values will be inherited by the resulting purchase agreement. You're not required to add

responsible workers to the purchase agreement, and they can be modified directly on a per case basis on the

purchase agreement itself. You can't specify a secondary responsible worker without a primary responsible

worker, although you don't have to have a secondary responsible worker. You can't specify the same worker as

both the primary and secondary responsible worker.

Before you can use the responsible party feature, it must be turned on in your system. Admins can use the feature

management settings to check the status of the feature and turn it on. In the Feature managementFeature management  workspace, the

feature is listed in the following way:

Module:Module:  Procurement and sourcing

Feature name:Feature name: Purchase agreement responsible party

Each line in a purchase agreement is a commitment to buy something. You can use lines from multiple purchase

orders (POs) to fulfill the commitment. There are four types of commitments:

Product quantity commitmentProduct quantity commitment – You purchase a specific quantity of a product.

Product value commitmentProduct value commitment – You purchase a specific currency amount of a product.

Product categor y value commitmentProduct categor y value commitment – You purchase a specific currency amount in a procurement

category. The amount can be for a catalog item or a non-catalog item.

Value commitmentValue commitment – You purchase a specific currency amount of any product or products in any

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/purchase-agreements.md


Pricing terms for purchase agreements

C O M M IT M EN T  T Y P EC O M M IT M EN T  T Y P E UN IT  P RIC EUN IT  P RIC E P RIC E  UN ITP RIC E  UN IT DISC O UN T  P ERC EN TDISC O UN T  P ERC EN T
C A SH  DISC O UN TC A SH  DISC O UN T
A M O UN TA M O UN T

Product quantity
commitment

Yes Yes Yes Yes

Product value
commitment

Yes

Product category
value commitment

Yes

Value commitment Yes

Policies for purchase agreements

Fulfillment calculations for purchase agreements

Confirmations and version history for purchase agreements

procurement category.

Pricing terms can vary, depending on the type of commitment. The pricing terms from purchase agreements

override any other pricing terms that are set up for trade agreements. The following table describes the price-

related fields that are affected by each commitment type. Fields that contain YesYes  can be updated on an order

line.

The following policies affect the way that the link between a purchase agreement commitment and the

corresponding PO lines works:

Max is enforcedMax is enforced – The total quantity or amount for all order lines can't exceed the quantity or amount that

is specified on the related commitment.

Pr ice and discount is fixedPrice and discount is fixed – The price on an order line and the price on the related commitment must be

the same. If the price is changed on the order line, the link to the commitment is broken. If the link is broken,

the order line doesn't contribute to the fulfillment of the commitment.

Minimum release amount and Maximum release amountMinimum release amount and Maximum release amount – If an amount is specified, you receive a

message if you make any change to an order line that causes the order line to differ from the related

commitment.

Fulfillment quantities and amounts are shown on the Fulfil lmentFulfillment tab on the L ine detailsL ine details  FastTab of the

Purchase agreementsPurchase agreements  page.

The FulfillmentFulfillment area shows the remaining amount or quantity that is required to fulfill the commitment.

The AgreementAgreement area shows the total quantity or the total amount that the sales agreement line is valid for.

You can access the PO lines and the invoice lines that contribute to the fulfillment calculation by selecting the

Related informationRelated information action on the lines or on the header of a purchase agreement.

When you confirm a purchase agreement, the current version of the purchase agreement is stored in a history

table. If you change the purchase agreement, you can confirm it again to store another version of the purchase

agreement in the history. If you don't confirm a purchase agreement, you can still use it to create POs. However,

the history information for the purchase agreement isn't stored. You can preview or print all versions of the



Applying purchase agreements in the ordering process

Matching policy on purchase agreements

Purchase agreements and intercompany trade

Financial dimensions on purchase agreements

Additional resources

agreement. You can then share the revisions with your vendor to obtain approval.

When you create a PO, you can apply a purchase agreement to it. Information from the terms for the agreement,

such as the payment terms, delivery terms, and delivery address, is then copied to the header of the PO. If the

PO contains one or more lines for products or categories that are covered by the agreement, the prices and

discounts from the purchase agreement are used for those lines. The amount or quantity on the order line

contributes to the fulfillment of the commitment in the purchase agreement. The same PO can include both lines

that aren't related to a purchase agreement and lines that have a commitment for a purchase agreement.

You can select a purchase agreement only when you're creating a PO. You can't select a purchase agreement

after the PO has been created.

In some situations where POs are created indirectly, you can control whetherSupply Chain Management

automatically searches for applicable purchase agreements. For example, you might do this when you're

automatically firming planned POs or creating POs that are based on sales orders.

You can define a line matching policy on the header of the purchase agreement. This line matching policy will

respect the accounts payable parameters line matching policy when the Allow matching policy overr ideAllow matching policy overr ide

field on the Accounts payable parametersAccounts payable parameters  page (on the Pr ice and quantity matchingPrice and quantity matching FastTab) is set to

Higher than company policyHigher than company policy . Documents that reference the purchase agreement will use the line matching

policy that's defined on the purchase agreement header unless otherwise defined on the corresponding item,

item and vendor, or category purchasing policy.

Intercompany trading relationships can be created between vendor accounts and customer accounts that are in

different legal entities. When a sales order or PO is created for one of the parties, an intercompany order chain

is created. In the order chain, the sales order and PO are created in the appropriate legal entities.

You can create a purchase agreement or sales agreement for one of the intercompany trading parties. You can

then generate the corresponding sales agreement or purchase agreement for the other intercompany trading

party in the other legal entity.

If you create an intercompany PO that uses the intercompany purchase agreement in one legal entity, the

corresponding intercompany sales order uses the corresponding intercompany sales agreement in the other

legal entity. The fulfillment of the sales agreement commitments and the fulfillment of the purchase agreements

are synchronized, just as the intercompany sales order and the intercompany PO are synchronized.

You can copy financial dimensions to document headers or to individual lines of a purchase agreement. If you

change the dimensions in the agreement header or on the agreement line, the change doesn't affect any

released orders, but it will be reflected on any new orders.

Create a purchase agreement

Create a purchase release order from a purchase agreement



NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a purchase agreement
2/18/2021 • 2 minutes to read • Edit Online

Create a new purchase agreement

Add a commitment

This topic guides you through the creation of a purchase agreement. This would typically be done by a

purchasing manager. You can use this procedure in demo data company USMF or on your own data. You need to

have set up purchase agreement classifications before you start. Once you've created an agreement you can use

it when you create a PO, and this will copy the purchase agreement conditions to the header and to any lines in

the order that are affected by the agreement.

1. Go to Navigation pane > Modules > Procurement and sourcing > Purchase agreements >Navigation pane > Modules > Procurement and sourcing > Purchase agreements >

Purchase agreementsPurchase agreements .

2. Click NewNew .

3. In the Vendor accountVendor account field, select the drop-down menu and select the row of the desired record.

4. In the Purchase agreement classificationPurchase agreement classification field, select the drop-down menu and select the row of the

desired record.

5. Expand the GeneralGeneral  FastTab.

6. In the Expiration dateExpiration date field, enter a date.

This expiration date will be the default for all commitment lines and will determine how long each

specific commitment is valid.

7. In the Document titleDocument title field, type a name for your purchase agreement.

Leave the Default commitmentDefault commitment field set to Product quantity commitmentProduct quantity commitment (or change it if it's not

set to this).

The default commitment value determines your options on the agreement lines. If you need a new

commitment type when you're creating the agreement lines, you need to change the default

commitment on the header. There are 4 types of commitments: Product quantity commitmentProduct quantity commitment -

for a specific quantity of a product; Product value commitmentProduct value commitment - for a specific currency amount of

a product; Product categor y value commitmentProduct categor y value commitment - for a specific currency amount in a procurement

category where the amount can be for a catalog item or a non-catalog item; Value commitmentValue commitment -

for a specific currency amount which can be fulfilled by any product or by any procurement category.

8. Select OKOK.

1. Select Add lineAdd line.

2. In the Item numberItem number  field, select the desired record from the drop-down menu.

3. In the QuantityQuantity  field, enter a number. This is the total quantity that you have agreed to buy from your

vendor.

4. In the Unit pr iceUnit pr ice field, enter a number.

5. Expand the L ine detailsL ine details  section.

6. Set the Max is enforcedMax is enforced option to YesYes . The Max is enforcedMax is enforced option limits the use of the commitment. You

can only purchase up to the quantity that's specified in the QuantityQuantity  field for the line.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/tasks/create-purchase-agreement.md


Add header conditions

Confirm and activate the agreement

NOTENOTE

1. On the Action Pane, select OptionsOptions .

2. Select Change viewChange view .

3. Select Header viewHeader view .

4. Expand the TermsTerms section.

5. In the Method of paymentMethod of payment field, select the desired record in the drop-down menu. The payment terms

from the vendor account are shown here by default.

6. In the Mode of deliver yMode of deliver y  field, select the desired record in the drop-down menu.

7. In the Deliver y termsDeliver y terms field, select the drop-down button to open the lookup.

1. On the Action Pane, select Purchase agreementPurchase agreement.

2. Select ConfirmationConfirmation. Set the Mark agreement as effectiveMark agreement as effective option to YesYes .

3. Select OKOK.

4. On the Action Pane, select Purchase agreementPurchase agreement.

5. Select Purchase agreement confirmationsPurchase agreement confirmations . The Preview/PrintPreview/Print option allows you to generate a

document for the purchase agreement which you can then print or send to the vendor. If you update the

agreement later on and re-confirm it, both versions will be shown here.

6. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Set up charges codes

Create charge groups

Based on the customer that you're working with or the item that you're selling, you might want to apply specific

additional charges. The charges feature in Microsoft Dynamics 365 Supply Chain Management helps you

automatically allocate charges to purchase orders or sales orders.

Automatic charges, or auto charges, are automatically applied when you create a sales order or a purchase

order. You can define auto charges for specific vendors, customers, groups of vendors, or items. You can also

define auto charges that apply to all vendors, customers, or items.

To allocate charges, you must first define charges codes.

1. Follow one of these steps:

For purchase orders: Go to Accounts payable > Charges setup > Charges codeAccounts payable > Charges setup > Charges code.

For sales orders: Go to Accounts receivable > Charges setup > Charges codeAccounts receivable > Charges setup > Charges code.

2. On the Action Pane, select NewNew  to create a charges code.

3. In the header of the new record, set the following fields:

NOTENOTE

Charges codeCharges code – Enter a code for the charges.

Descr iptionDescr iption – Enter a description of the charges.

Item sales tax groupItem sales tax group – Select an item sales tax group, if applicable.

ProrateProrate – Set this option to Yes if you want to prorate your charges. This option is available only

for sales orders.

Maximum amountMaximum amount – Enter the maximum amount that is allowed for the charges code. This field

is used to validate charges for vendor invoices. It's available only for purchase orders.

To turn on the functionality for validating charges for purchase orders, go to Accounts payable >Accounts payable >

Setup > Accounts payable parametersSetup > Accounts payable parameters . On the Invoice validationInvoice validation FastTab, in the InvoiceInvoice

validationvalidation section, set the Enable invoice matching validationEnable invoice matching validation option to Yes.

4. The PostingPosting FastTab includes DebitDebit and CreditCredit sections. Set the following fields, depending on the

ledger that you want to post the charges to:

TypeType – Select the type of account that you're posting to (Ledger, Customer, or Item).

PostingPosting – Select the type of postings to create (such as Broker fee or Customer settlement).

AccountAccount – Select the account to post the charge for.

5. On the Action Pane, select SaveSave.

Charge groups automatically allocate specific charges to a group of customers or vendors. The following

subsections describe how to create and assign these charge groups.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/automatic-charges-allocation.md


Charge groups for purchase ordersCharge groups for purchase orders

Charge groups for sales ordersCharge groups for sales orders

Define auto charges

To create charge groups for purchase orders, follow these steps.

1. Go to Accounts payable > Charges setup > Vendor charges groupAccounts payable > Charges setup > Vendor charges group.

2. On the Action Pane, select NewNew  to add a row to the grid, and then set the following fields:

Charges groupCharges group – Enter the name of the charge group.

Descr iptionDescr iption – Enter a description of the charge group.

3. On the Action Pane, select SaveSave.

4. Go to Accounts payable > Vendors > All vendorsAccounts payable > Vendors > All vendors , and either open an existing vendor or create a

new vendor.

5. On the Purchase order defaultsPurchase order defaults  FastTab, in the Purchase orderPurchase order  section, set the Charges groupCharges group field

to the charge group that you just created.

To create charge groups for sales orders, follow these steps.

1. Go to Accounts receivable > Charges setup > Customer charge groupsAccounts receivable > Charges setup > Customer charge groups .

2. On the Action Pane, select NewNew  to add a row to the grid, and then set the following fields:

Charges groupCharges group – Enter the name of the charge group.

Descr iptionDescr iption – Enter a description of the charge group.

3. On the Action Pane, select SaveSave.

4. Go to Accounts receivable > Customers > All customersAccounts receivable > Customers > All customers , and either open an existing customer or

create a new customer.

5. On the Purchase order defaultsPurchase order defaults  FastTab, in the Sales orderSales order  section, set the Charges groupCharges group field to

the charge group that you just created.

After your charges codes are set up, follow these steps to define the auto charges.

1. Follow one of these steps:

For purchase orders: Go to Procurement and sourcing > Setup > Charges > AutomaticProcurement and sourcing > Setup > Charges > Automatic

chargescharges .

For sales orders: Go to Accounts receivable > Setup > Charges setup > Auto chargesAccounts receivable > Setup > Charges setup > Auto charges .

2. In the list pane, in the LevelLevel  field, select the level where your auto charge applies:

Main – Apply charges to the order header.

Line – Apply charges to the order lines.

3. Select an existing auto charge to edit it, or select NewNew  to define a new auto charge.

4. In the Account codeAccount code list, select one of the following values to specify the scope of accounts that will be

affected:

Table – Assign charges to a specific customer or vendor.

Group – Assign charges to a miscellaneous charges group.

All – Assign charges to all customers or vendors.

5. In the Customer relationCustomer relation or Vendor relationVendor relation field, select a specific customer or vendor if you set the

Account codeAccount code field to Table. If you set the Account codeAccount code field to Group, select a customer or vendor



charges group.

6. In the Item codeItem code field, select one of the following values to specify the scope of items that will be

affected. You can select an item code only when you define auto charges at the line level.

Table – Assign charges to a specific item.

Group – Assign charges to an item charges group.

All – Assign charges to all items.

7. In the Item relationItem relation field, select a specific item if you set the Item codeItem code field to Table. If you set the ItemItem

codecode field to Group, select an item charges group.

8. For sales orders only:For sales orders only: In the Mode of deliver y codeMode of deliver y code field, select one of the following values to

specify the scope of delivery modes that will be affected:

Table – Assign charges to a specific mode of delivery.

Group – Assign charges to a mode of delivery group.

All – Assign charges to all modes of delivery.

9. For sales orders only:For sales orders only: In the Mode of deliver y relationMode of deliver y relation field, select a specific mode of delivery if you

set the Mode of deliver y codeMode of deliver y code field to Table. If you set the Mode of deliver y codeMode of deliver y code field to Group,

select a mode of delivery group.

10. On the L inesLines  FastTab, define the charges and the charges rates that will be used when the current auto

charge is applied. You can use the toolbar on this FastTab to add as many lines as you require. For each

line, set the following fields:

CurrencyCurrency  – Select the currency that should be used to calculate the charge.

Charges codeCharges code – Select the code for the charge.

Categor yCategor y  – Select one of the following values:

Fixed – The charge is entered as a fixed amount on the line. Fixed charges can be used on

charges both in the order header and on the order lines.

Pcs – The charge is based on the unit. These charges can be used only on order lines. They will

appear when you calculate the order total.

Percent – The charge is entered as a percentage on the line. Percentage charges can be used on

charges both in the order header and on the order lines.

Intercompany percent – The charge is entered as a percentage on the line for intercompany

orders. Intercompany percentage charges can be used only on order lines.

External – The charge is calculated by a third-party service that is associated with one or more

shipping carriers.

Charges valueCharges value – Enter the charge value, based on the category that you selected.

Charges currency codeCharges currency code – Specify a currency for the charge if you want to use a currency other

than the currency that you specified in the CurrencyCurrency  field. You can use a different currency only if

the Debit typeDebit type or Credit typeCredit type field is set to either Ledger account or Item for the selected

charges code.

From amountFrom amount – Specify a starting amount to apply the auto charge to. In this context, the amount

refers to the order total.

To amountTo amount – Specify the ending amount to apply the auto charge to. In this context, the amount

refers to the order total.

Sales tax groupSales tax group – Specify a sales tax group.

S iteSite and WarehouseWarehouse – Specify a site and warehouse if charges should be applied only for a



Allocate charges from the header to a line

specific site and warehouse.

KeepKeep – Select this check box to keep the charges transactions after invoicing is completed, so that

the charge will be applied every time that you create a new invoice for the selected customer

account.

11. For sales orders only:For sales orders only: If you want to calculate tiered charges, see Tiered charges on sales orders for

information.

The following procedure shows how to allocate header-level charges to a line. Before you start this procedure,

you should already have a header-level charge of the fixed amount type and an order where that charge is

applied. Additionally, the order should already include at least one line item.

1. Open the purchase order or charge order.

2. On the Action Pane, follow one of these steps:

For purchase orders: On the PurchasePurchase tab, in the ChargesCharges  group, select Allocate chargesAllocate charges .

For sales orders: On the SellSell  tab, in the ChargesCharges  group, select Allocate chargesAllocate charges .

3. In the Allocate charges to order linesAllocate charges to order lines  dialog box, set the following fields:

IMPORTANTIMPORTANT

Charges allocationCharges allocation – Select one of the following values to specify how the charges should be

allocated:

Net amount – Allocate charges according to each line amount relative to the total net amount.

Quantity – Allocate charges according to the number of units for each line relative to the total

number of units.

Per line – Allocate charges equally among the total number of lines.

Allocate charges to linesAllocate charges to lines  – Select a value to specify whether charges should be allocated to all

lines, to positive lines only, or to negative lines only.

Allocate allAllocate all  – Select this check box to allocate charges to order lines even if the charges code has

a debit type other than Item.

ReceivedReceived – Select this check box to allocate charges only to received order lines.

StockedStocked – Select this check box to allocate charges to only inventoried order lines.

Show selections and clear specific linesShow selections and clear specific lines  – Select this check box to exclude specific lines from

this allocation. When you select this check box, the Choose lines to exclude from allocationChoose lines to exclude from allocation

grid is opened. This grid includes only lines that match the criteria that are defined by the AllocateAllocate

charges to linescharges to lines  and StockedStocked settings. For example, if you set the Allocate charges to linesAllocate charges to lines

field to Positive lines and select the StockedStocked check box, the grid shows only lines that are both

positive and inventoried. In addition, the grid automatically filters out any lines that the full

quantity has already been received for. While the grid is open, clear the IncludeInclude check box for each

line that should be excluded from allocation.

When you work with the Choose lines to exclude from allocationChoose lines to exclude from allocation grid, be sure to leave the grid open

until you select AllocateAllocate. If you close the grid before you select AllocateAllocate, your settings in the grid will be

lost. Therefore, charges will be allocated based on the criteria that you previously defined.

4. Select AllocateAllocate to apply your settings and close the dialog box.

https://docs.microsoft.com/en-us/dynamicsax-2012/appuser-itpro/about-tiered-charges-on-sales-orders
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Audience and purpose

Review details of a vendor rebate agreement

Vendor rebates help companies better manage their supplier rebate programs by automating tasks that are

required in order to administer, track, and claim rebates that are earned.

This topic provides an overview of the most common tasks that you might want to perform when you work with

vendor rebates. The overview covers the following tasks:

Review details of a rebate agreement.

Identify orders that qualify for rebates, and generate rebate claims.

Review and approve claims.

The information in this topic is intended for business decision makers in enterprise companies, in positions such

as purchase manager, chief financial officer (CFO), and accounting manager, who have the following

responsibilities:

Negotiate vendor price, discount, and rebate agreements.

Manage staff that processes rebate claims and collects payments.

Order inventory at the best possible prices.

People in these positions are looking for ways to achieve various goals. Here are some examples:

Flexibly accommodate different types of vendor promotion programs and rebate conditions.

Reduce the administrative burden and errors that are associated with monitoring promotion performance

and processing claims.

Improve cash flow forecasts by accruing for future receivables.

Have a quantified basis for ongoing and future negotiations with vendors about rebates.

A vendor rebate agreement is a record of a contract with a vendor that specifies the negotiated terms and

conditions under which the company qualifies for a monetary reward in return for achieving preset purchase

targets. Vendor rebate agreements are recorded on the Rebate agreementsRebate agreements  page.

To open the Vendor rebate agreementsVendor rebate agreements  page, select Procurement and sourcingProcurement and sourcing > Vendor rebatesVendor rebates  >

Rebate agreementsRebate agreements .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/vendor-rebates.md


On the Vendor rebate agreementsVendor rebate agreements  page, you can view details about the negotiated conditions of a vendor

agreement.

The agreement's header specifies the general conditions that qualify a company for rebates. In effect, the header

information specifies that a vendor grants a rebate when a specific product is bought in a specific quantity. On

the header, you also specify the unit of measure rebate option and the calculation date type.

On the Over viewOver view  tab, if you have lines with Item codeItem code set to table to specify the item, then the

agreement is for that specific item. If you have lines with Item codeItem code set to Group or All to specify the

items, then the vendor rebate agreement will be individually processed per item qualifying for the item

code, not across all items qualifying for the item code.

On the GeneralGeneral  tab, in the Unit of measure rebate optionUnit of measure rebate option field, you can define whether a unit of

measure should be a condition for the purchase order line to qualify for a rebate claim.

Conver tConver t – A purchase order line qualifies for a vendor rebate per the rebate agreement. You will

receive a rebate regardless of the unit of measure that is applied on the line.

Exact matchExact match – To qualify for a rebate, a purchase line must have the same unit of measure that is

specified on the agreement.

On the GeneralGeneral  tab, in the Calculation date typeCalculation date type field, select the date that is used to determine

whether the purchase occurs in the validity period of the rebate agreement.

CreatedCreated – Use the creation date of the purchase order.

Requested deliver yRequested deliver y  – Use the requested delivery date.

On the agreement lines, you can specify the vendor rebate agreement in more detail.

In the Cumulate purchase byCumulate purchase by  field, you can set the calculation of the rebate claim. The amount can be

set to depend on a period (of week, month, year, lifetime or a customized period). The InvoiceInvoice value

indicates that a rebate claim will be determined every time that a purchase order line is invoiced.

In the Taken fromTaken from field, you can specify the basis for the rebate calculation.

GrossGross  – The rebate is calculated based on the gross price of the item.

NetNet – The rebate is calculated based on the net price of the item (that is, the price after other discounts

have been applied).

The Rebate program accrual accountRebate program accrual account and Rebate program expense accountRebate program expense account fields specify account

numbers that will receive accrued rebate amounts during the intermediate stage between approval and

processing.

When the Approval requiredApproval required option is set to YesYes , the rebate claim must be approved before it can be



Identify orders that qualify for rebates, and generate rebate claims

View details of rebates that are applied to a purchase order line per the vendor rebate agreementView details of rebates that are applied to a purchase order line per the vendor rebate agreement

NOTENOTE

Review and approve claims

The status of claims and the effect on the approval processThe status of claims and the effect on the approval process

NOTENOTE

accrued or paid out.

The Rebate line break typeRebate line break type field specifies the basis for the rebates.

QuantityQuantity  – The rebates are volume-based.

AmountAmount – The rebates are amount-based.

On the L inesLines  FastTab, you can see how different quantity tiers can be set up to grant different rebates. For

example, in the previous illustration, the From valueFrom value and To valueTo value fields indicate that a product quantity

between 10 and 19 units will qualify for a rebate of USD 15 per unit.

The From valueFrom value value is inclusive, whereas the To valueTo value value is exclusive. For example, the Rebate line breakRebate line break

typetype field is set to QuantityQuantity , and you enter 11  in the From valueFrom value field and 33  in the To valueTo value field. In this case,

the rebate amount applies when you purchase one or two items, but not when you purchase three items.

In the Workflow approval statusWorkflow approval status  field, the ApprovedApproved value indicates that the agreement can be

applied to purchase orders that meet the agreement’s conditions.

When purchase orders are placed with a vendor that the company has a rebate agreement with, the program

identifies any future vendor credit payments. If the purchase orders qualify for a rebate, a rebate claim is

generated for every order line as soon as a purchase invoice has been posted. This process is automatic. Later,

you can review the expected rebates and see the impact of those rebates on the product’s cost and profit

margin.

1. On the Purchase orderPurchase order  page, select an order line, and then select Purchase order linePurchase order line > ViewView  > Pr icePrice

detailsdetails .

2. On the Pr ice detailsPr ice details  page, select the RebatesRebates  FastTab.

The rebate information is also shown in the Vendor rebateVendor rebate field in the Margin estimationMargin estimation section of the

Price detailsPr ice details  page.

On the Procurement and sourcing parametersProcurement and sourcing parameters  page, on the PricesPrices tab, verify that the Enable price detailsEnable price details  option

is set to YesYes . If the option is set to NoNo, you won’t be able to view the rebates.

Rebate claims that are generated represent the future payments that can be expected from the vendor. Before a

credit note is issued to the vendor, the agreement owner typically wants to review the claims and approve them.

However, note that the status of a claim determines whether the claim is ready to go through the approval

process.

When a claim is generated, its status is set to To be calculatedTo be calculated if the rebate is granted on a cumulative basis or

CalculatedCalculated if the rebate is granted per invoice. If the status of a claim is To be calculatedTo be calculated, the claim must go

through a calculation process that is handled by the Cumulate function. Only claims that have a status of

CalculatedCalculated can be included in the approval process.



NOTENOTE

Approve claims, and view postings and invoice detailsApprove claims, and view postings and invoice details

If the Approval requiredApproval required option on a vendor rebate agreement is set to NoNo, any claims that are generated will have a

status of ApprovedApproved. The approval is mandatory for claims that are granted on a cumulative basis.

When claims have been approved, they can be processed by Accounts payable (A/P). A credit memo (vendor

invoice) for the rebate claim amount is automatically generated. The credit can then be added to the vendor

balance, and the A/P team can include it in the regular settlement process.

1. Select Procurement and sourcingProcurement and sourcing > Vendor RebatesVendor Rebates  > Rebate claimsRebate claims  to open a rebate claim.

2. Close the rebate claim.

3. Mark the claim, and then, on the Action Pane, select ApproveApprove.

4. On the request page, in the VendorVendor  field, select the vendor that you’re authorized to receive a rebate

from, and then select OKOK.

A Rebate accrual journal is posted for the claim amount. This posting debits the Accrued Vendor Rebates

Receivable account for the expected vendor credit and credits the interim Accrued Vendor Rebates

Received account for the expected gain.

5. In the rebate list, select the line, and then, on the Action Pane, select Rebate transactionsRebate transactions  to see and

navigate to the journal batch number for this rebate accrual posting.

To move the claims to the regular A/P process, the A/P clerk must now complete the rebate claim

handling by running the Process function.

6. On the Action Pane, select ProcessProcess , and then select FilterFilter . In the Criter iaCriter ia field for the Vendor accountVendor account

field, select the vendor to process rebate claims for, select other relevant filters, and then select OKOK.

The message bars and the fact that the status is changed to CompletedCompleted indicate that the following

events have occurred:

NOTENOTE

A Rebate accrual journal posting has reversed the previous interim amounts on the accrual

receivable and expense accounts.

A vendor invoice (credit note) for the rebate amount has been created.

The setting of the Manual invoice postingManual invoice posting option on the Rebate programRebate program tab of the ProcurementProcurement

and sourcing parametersand sourcing parameters  page determines whether a vendor invoice is posted manually or

automatically as part of claim processing.

When the vendor invoice is posted, either automatically or manually, the vendor’s Payable account

has been debited, and the Discounts and Allowances Received account has been credited.



Summary

NOTENOTE

NOTENOTE
The Discounts and Allowances Received account number is specified for the procurement category that is

used on the purchase invoice line for the rebate. The procurement category, in turn, is set on the RebateRebate

programprogram tab of the Procurement and sourcing parametersProcurement and sourcing parameters  page.

7. In the rebate list, select the line, and then, on the Action Pane, select Rebate transactionsRebate transactions  to see and

navigate to the journal batch number for this rebate accrual posting and also the vendor invoice number.

8. Select the line for the vendor invoice transaction, and then, on the Action Pane, select Vendor invoiceVendor invoice. If

the vendor invoice has been posted, you will see the Invoice journal. Otherwise, you will see the vendor

invoice as a pending vendor invoice that requires manual posting.

The invoice line specifies the details of the vendor invoice for the Commissions and RebatesCommissions and Rebates

procurement category.

9. On the All vendorsAll vendors  page, select the vendor that you receive a rebate from, and then, on the Action Pane,

select TransactionsTransactions . Find the line for the invoice. The rebate amount has now been added to the vendor

balance.

The process for handling vendor rebates involves multiple manual tracking tasks that are often tedious. By

automating these tasks, the vendor rebate management feature can help you move through the following

processes:

Generating accurate rebate claims

Accruing the expected receivable and interim gain in the general ledger

Updating the vendor balance and the income statement with the allowance that is due
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Troubleshoot prices, discounts, agreements, and
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I can't link a purchase agreement to a purchase order line after the
purchase order is created.

What check triggers the "Update prices and discounts entered
manually or external document" message?

A purchase order receipt doesn't include all charges.
Reproduce the issueReproduce the issue

Issue resolutionIssue resolution

Trade agreement prices and discounts aren't applied on sales or
purchase order lines that are imported through data management.

This topic describes how to fix issues that you might encounter while you work with prices, discounts,

agreements, and rebates.

A purchase agreement must be associated with a purchase order when the purchase order is created.

Otherwise, purchase order lines can't be associated with purchase agreement lines.

When you change the shipping date, you might receive a message that states, "Update prices and discounts

entered manually or external document." You receive this message because, if the shipping date is changed, a

different trade or sales agreement might be triggered and cause a price change. A change to the shipping date

can also affect warehouse schedules and other related information.

The message is triggered whenever any of the dates or some other parameters are changed. The purpose of the

message is to make sure that you're aware of price changes that can occur because of those changes.

The message is the trade agreement evaluation (TAE) prompt. For a full description, see Trade agreement

evaluation policies.

The following procedure shows one way to reproduce the issue.

1. On the Procurement and sourcing parametersProcurement and sourcing parameters  page, on the Deliver yDeliver y  tab, make sure that the GenerateGenerate

charges on product receiptcharges on product receipt option is set to Yes.

2. Create a purchase order that includes charges.

3. Confirm the purchase order.

4. Receive the purchase order.

5. Look at the receipt total, and compare it to the expected total.

6. Notice that not all the charges are included on the purchase order receipt.

The resolution depends on the way that the miscellaneous charges have been set up. For information about how

to set up miscellaneous charges to meet your requirements, see the following blog post: Post misc. charges at

time of product receipt.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/troubleshooting-pricediscountagreements.md
https://docs.microsoft.com/en-us/dynamicsax-2012/appuser-itpro/trade-agreement-evaluation-policies-white-paper
https://cloudblogs.microsoft.com/dynamics365/no-audience/2014/11/11/post-misc-charges-at-time-of-product-receipt/


Issue descriptionIssue description

Reason for the issueReason for the issue

Issue workaroundIssue workaround

A vendor rebate isn't cumulated based on invoices.
Issue descriptionIssue description

Issue resolutionIssue resolution

Unit prices on purchase orders aren't calculated based on the unit
conversion.
Issue descriptionIssue description

Issue resolutionIssue resolution

Issue workaroundIssue workaround

Currency conversion issues occur with trade agreements.

Trade agreements that are applicable to sales or purchase order lines aren't applied on lines that are imported

through data management. However, the same trade agreements are applied on sales or purchase order lines

that are manually created.

If purchase order lines that are imported via data management already include price information, the trade

agreement won't be reevaluated for those lines. For example, if L ine discount percentageLine discount percentage or any of the price

and discount values is set for a line, then trade agreements will not be looked up for that line.

This behavior is expected, and is similar for both sales orders and purchase orders.

As a workaround, import the purchase order lines without setting any price information. The trade agreements

will then be applied, and the purchase order lines will be updated based on the defined trade agreements.

If invoices that are posted have different due dates, those invoices aren't reflected in vendor rebates that are

generated from them.

By design, the due date isn't considered when the vendor rebate is calculated. Consider customizing the system

so that the due date and the relation to the invoice are more apparent with respect to the actual vendor rebate.

When a unit is changed on a purchase order, trade agreement prices aren't recalculated according to unit

conversion definitions.

Prices are always obtained from trade agreements (or other price settings in the system, such as sales

agreements or item prices), and they are set for a unit.

If the unit is changed on an order line, the system looks for a price for the new unit and applies that price. If no

price is found for the unit, the system doesn't apply a price. The unit conversion can't be used to recalculate the

price into another unit. Theoretically, the price for one box of ten might not equal ten times the price of one box.

One way to work around this issue is to make sure that there are trade agreements for the units that you expect

will be used on order lines for the item.

Trade agreement prices aren't recalculated according to the currency when the currency differs on a purchase

order.

The Generic currency feature lets you define prices and discounts in only one currency. You can then convert to

other currencies as you require. Furthermore, after the conversion is done, the feature can automatically apply

smart rounding.



When I open the Purchase agreement page in a line view mode, I
can't personalize the page by adding the Price unit field in the
overview of the line.

The maximum limit from a purchase agreement isn't effective on a
purchase requisition.
Issue descriptionIssue description

Issue resolutionIssue resolution

Trade agreements can be created from rejected RFQs. Therefore, the
system doesn't prevent trade agreement journals from being created
if the RFQ line hasn't been accepted.

NOTENOTE

Some shared fields in the agreement framework can't be included in personalizations. This limitation occurs

because of the data model that is implemented. Therefore, you can't personalize the Pr ice unitPr ice unit field.

When a purchase requisition is linked to a purchase agreement, the maximum limit from the purchase

agreement isn't effective on the purchase requisition. The default price information is correctly entered, but

more than the maximum limit from the purchase agreement can be ordered in the purchase requisition.

This behavior is expected. Because requisitions aren't always approved, a quantity or amount should not be

reserved on the purchase agreement. Therefore, you won't meet the maximum limit from the purchase

agreement.

You can create trade agreements for any replies for a request for quotation (RFQ), regardless of whether they

were accepted or rejected. For more information, see Requests for quotation (RFQs) overview.
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Assigning policies to organizations

Determining which rule to apply

Example 1: Simple purchasing policy configurationExample 1: Simple purchasing policy configuration

Example 2: Complex purchasing policy configurationExample 2: Complex purchasing policy configuration

This article provides information about purchasing policies. A purchasing policy is a collection of rules that

control the requisition process. Purchasing policies help procurement administrators implement their

procurement strategy by creating a policy structure that is aligned with the organization’s strategic purchasing

requirements.

A purchasing policy consists of a set of policy rules. When you define a policy rule, you first select a rule type.

You then create a rule for the rule type by defining the settings, the start date, and the end date for the rule.

For example, an administrator creates a policy, selects the Catalog policyCatalog policy  rule type, and then adds a catalog

policy rule to the policy. This catalog policy rule specifies that the Adventure catalog must be used for internal

procurement. After the purchasing policy is associated with a particular organization, employees of that

organization see the Adventure catalog when they create requisitions.

Before a policy can take effect, it must be associated with an organization. Purchasing policies are associated

with the Procurement internal controlProcurement internal control  hierarchy purpose. Therefore, purchasing policies apply only to

organizations in hierarchies that have a hierarchy purpose of Procurement internal controlProcurement internal control . You can also

select organizations from the flat list of legal entities in the CompanyInfo table. These legal entities are

designated in the policy framework as “Companies.”

Depending on how you configure your purchasing policies, multiple rules can affect the users in an

organization. The following examples illustrate different ways that you can configure purchasing policies and

specify how policies are applied when a transaction occurs.

Organizations that are small and less complex can set up purchasing policies by legal entity, and can use only

the Companies organization hierarchy.

For Fabrikam, a small business, purchasing requirements vary little across the organization. Purchasing rules

vary only among the organization's legal entities. For example, employees of Fabrikam Canada and employees

of Fabrikam U.S. purchase goods and services from different catalogs and different vendors. Therefore,

Fabrikam sets up its purchasing policies at the legal-entity level.

Fabrikam creates two purchasing policies. Policy A applies to its U.S. legal entity, 1111. Policy B applies to its

Canadian legal entity, 2222. When an employee in legal entity 1111 creates a purchase requisition, the policy

rules are derived from policy A. For example, the product catalog that the employee sees is specified in the

catalog policy rule for policy A.

When an employee in legal entity 2222 creates a purchase requisition, the policy rules are derived from policy B.

Note:Note: If an employee of legal entity 1111 purchases an item on behalf of an employee of legal entity 2222, the

policy rules that are specified for legal entity 2222 (that is, the policy rules from policy B) are applied.

In the previous example, all purchasing rules were defined in a single organization hierarchy, the Companies

organization hierarchy. However, a complex organization might define policies for multiple organization

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/purchase-policies.md


Policy rules
Catalog policy ruleCatalog policy rule

Category access policy ruleCategory access policy rule

Category policy ruleCategory policy rule

Re-approval rule for purchase ordersRe-approval rule for purchase orders

hierarchies.

Contoso is a large company that requires complex purchasing rules to control the requisition process. Contoso

has defined rules for two different organization hierarchies: Department and Global purchasing control.

Policy 123 is defined for the Department organization hierarchy for the Sales UK – Sales department. In policy

123, the purchase requisition control rule specifies that restrictions must be enforced for minimum order

quantities. In this rule, the Enforce minimum order quantity restr ictionsEnforce minimum order quantity restr ictions  option is selected.

Policy 456 is defined for the Global purchasing control organization hierarchy for the Sales and Marketing

department. In policy 456, the purchase requisition control rule doesn't specify that restrictions must be

enforced for minimum order quantities. In this rule, the Enforce minimum order quantity restr ictionsEnforce minimum order quantity restr ictions

option is de-selected.

Sam works in the Sales UK – Sales department in Contoso’s United Kingdom office. The policies for both the

Department and Global purchasing control organization hierarchies apply to his department. When Sam creates

a purchase requisition, the system must determine which policy to apply. The system administrator set up the

purchasing policy parameters to specify that purchasing policies must be applied in the following order of

precedence:

1. Global purchasing control

2. Department

3. Companies

Therefore, policy 456 is applied to the purchase requisition that Sam creates, and no minimum order quantity is

required for the purchase requisition.

The catalog policy rule determines which procurement catalog users see when they create purchase requisitions.

If a user has been granted permission to order products on behalf of another user, the requisition uses the

catalog policy rule that is defined for the requester ’s legal entity and operating unit to determine which catalog

to display. Before you can define a catalog policy rule, you must create and publish a procurement catalog.

The category access policy rule determines which categories users have access to when they create purchase

requisitions. If no rule is specified, all the procurement categories can be added to the purchase requisition.

1. Select the Include parent ruleInclude parent rule option to apply the category access policy rule of the parent organization to

the category.

2. In the Available categoriesAvailable categories  pane, select the categories that the rule applies to. When you select a category,

all categories that are higher in the hierarchy are also added to the Selected categoriesSelected categories  list.

3. Select the Include subcategoriesInclude subcategories  option to apply the rule to all subcategories of the selected category.

The category policy rule defines how users can select vendors for each category. It also defines requirements for

the receiving and invoicing processes.

The re-approval rule is an optional rule that defines the criteria for requiring re-approval when a purchase order

is changed. The selected fields are evaluated in the purchase order workflow when the "Requires purchase order

re-approval" condition is set up in the workflow.
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Purchase requisition RFQ rulePurchase requisition RFQ rule

Purchase requisition control rulePurchase requisition control rule

Requisition purpose ruleRequisition purpose rule

Replenishment category access policy ruleReplenishment category access policy rule

Replenishment control ruleReplenishment control rule

Purchase order creation and demand consolidation rulePurchase order creation and demand consolidation rule

Accounting distribution will always be reset when an approved purchase order with change management enabled is

changed. So you should be aware that if you want to avoid a re-approval of a purchase order when certain fields are

changed, the field Accounting distribution.changed should NOT be included as a selected field for re-approval.

The purchase requisition RFQ rule defines criteria for requiring a request for quotation (RFQ) for a purchase

requisition line. If a line meets the conditions, the "informal RFQ" or "formal RFQ" stamp appears on the

requisition line.

The purchase requisition control rule for requisitions of type consumptionconsumption is an optional rule. When you create

rules of this type, you can set options on various tabs:

On the Workflow submissionWorkflow submission tab, you can configure the fields that must be entered on the requisition line

for the requisition to be submitted for approval.

On the Order quantitiesOrder quantities  tab, you can configure the fields that are required on the purchase requisition

under certain conditions. You can also enforce order quantities.

On the DatesDates  tab, you can configure whether the accounting date is the same as the requested date

On the AddressAddress  tab, you can define whether the user is allowed to create new addresses in the system to

apply to the purchase requisition.

The requisition purpose rule is an optional rule that determines the type of requisition purpose that is allowed

for a specific legal entity. Unless another purpose is indicated in this rule, requisitions automatically have a

purpose of ConsumptionConsumption when they are created.

The replenishment category access policy rile is an optional rule that determines the products that are available

to fulfill requisition demand for a specific legal entity when the requisition purpose is ReplenishmentReplenishment.

The replenishment control rule is an optional rule that defines the fields that must be entered on the requisition

line for the requisition to be submitted for approval when the requisition purpose is ReplenishmentReplenishment.

The purchase order creation and demand consolidation rule defines the policy rules to use when a purchase

order is generated from an approved purchase requisition. When you create rules of this type, you can set

options on various tabs:

On the Purchase order splitPurchase order split tab, you can define criteria for splitting purchase requisition lines onto

separate purchase orders.

On the Pr ice/discount transferPr ice/discount transfer  tab, you can define when to recalculate the price agreement when a

purchase order is created:

Only if no trade agreementOnly if no trade agreement – Prices and discounts are transferred from the purchase requisition

only if there is no applicable trade agreement or base price. If a trade agreement or base price exists

for the item or vendor, the prices and discounts are recalculated based on the trade agreement or the

base price, and are applied to the purchase order. Unless otherwise specified, this is the default

behavior.

AlwaysAlways  – Prices and discounts are always transferred from the purchase requisition.

You can also allow the requester to change the method of price and discount transfer for individual



purchase requisition lines, regardless of the price/discount transfer rule that is defined. Select the AllowAllow

manual overr ide per purchase requisition linemanual overr ide per purchase requisition line option to enable this capability.

On the Item descr iption transferItem descr iption transfer  tab, you can transfer the item description from the requisition when

it originates from an RFQ.

On the Pr ice TolerancePrice Tolerance tab, you can define rules to route approved purchase requisitions back through

the review process when the price of a procurement catalog item increases. Set the maximum amount

that the net amount on a line item on a purchase requisition can increase between the time when the

purchase requisition is approved and the time when the purchase order is created. The net amount is

calculated by using the following formula: ([Quantity × (Unit price – Discount) ÷ Price unit] + Purchase

miscellaneous charges) × (100 – Discount percent) ÷ 100 Purchase requisition lines that exceed the price

tolerance that you set are held for manual processing. The rules that you configure on the ErrorError

processingprocessing tab determine how the purchase requisition lines are processed.

On the Error processingError processing tab, you can configure the processing rule that is applied to a purchase

requisition if it fails validation during purchase order creation because of a vendor error or a price

tolerance error. Select one of the following options:

No actionNo action – The purchase requisition lines remain on the Release approved purchaseRelease approved purchase

requisitionsrequisitions  page. The status of the purchase requisition lines remains ApprovedApproved. However, the

errors must be resolved before a purchase order can be generated for the purchase requisition lines.

Cancel the purchase requisition lineCancel the purchase requisition line – The purchase requisition lines are canceled. The requester

can create a new purchase requisition for the canceled lines if he or she still wants to request the line

items.

Create a new purchase requisition lineCreate a new purchase requisition line – The purchase requisition lines are canceled. New

purchase requisitions are then generated that contain only the purchase requisition lines that failed

validation. The new purchase requisitions that are generated have a status of DraftDraft. These purchase

requisitions can be resubmitted for review after the validation errors have been resolved. The preparer

of the purchase requisition lines is notified that the lines were canceled, and that new purchase

requisitions were generated for the purchase requisition lines that failed.

On the Manual purchase order creationManual purchase order creation tab, you can define the parameters that determine whether a

purchase requisition must be manually processed, or whether it can be automatically converted to a

purchase order. The parameters can apply to internal catalog items, external catalog items, or non-catalog

items. Select one of the following options:

Manually create purchase ordersManually create purchase orders  – Manually create purchase orders for all purchase requisitions.

Automatically create purchase ordersAutomatically create purchase orders  – Automatically create purchase orders for all approved

purchase requisitions. No purchase requisitions are held for manual purchase order creation.

Automatically create purchase orders except under these conditionsAutomatically create purchase orders except under these conditions  – Manually create

purchase orders for purchase requisitions that match the criteria that you define. All other purchase

requisitions that are approved are automatically converted to purchase orders. If you select

Automatically create purchase orders except under these conditionsAutomatically create purchase orders except under these conditions , you can add

procurement categories and vendors to specify which approved purchase requisition lines are held for

manual processing. This option can apply to internal catalog items, external catalog items, and non-

catalog items. When you select a procurement category, any subcategories for that procurement

category are also selected. Select the AllAll  option for a specific type of purchase requisition line to hold

all lines of that line type for manual processing.

If you want purchase orders to be generated automatically from approved purchase requisitions when

the batch job for purchase order generation runs, select the Run automatic purchase order creationRun automatic purchase order creation

as a batch jobas a batch job option. This option applies only to purchase requisitions that don't require manual

processing. By running automatic purchase order generation as a batch job, you can schedule this activity

at a time when resources are less constrained. If the Prepayment requiredPrepayment required option is selected on the
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purchase requisition lines, select the When the requisition is set up for prepaymentWhen the requisition is set up for prepayment option to hold

approved purchase requisitions for manual processing. Purchase requisitions that are held for manual

processing can be filtered so that you can view only those purchase requisition lines that require

prepayment.

On the Demand consolidationDemand consolidation tab, you can define the parameters that determine whether purchase

requisitions that are manually processed can be considered for purchase requisition consolidation. The

parameters can apply to internal catalog items, external catalog items, or non-catalog items. Select one of

the following options:

Do not allow demand consolidationDo not allow demand consolidation – No approved purchase requisition lines are eligible for

demand consolidation. This option is selected by default and applies only to purchase requisition lines

that require manual processing for purchase order creation.

Always allow demand consolidationAlways allow demand consolidation – All approved purchase requisition lines are eligible for

demand consolidation. Note:Note: If you select the Always allow demand consolidationAlways allow demand consolidation option on the

Demand consolidationDemand consolidation tab, but you select the Automatically create purchase ordersAutomatically create purchase orders  option on

the Manual purchase order creationManual purchase order creation tab, all purchase requisitions are held for manual processing.

Allow demand consolidation under these conditionsAllow demand consolidation under these conditions  – Define the criteria that determine

whether approved purchase requisition lines are eligible for demand consolidation. For each type of

purchase requisition line, you can set the criteria by procurement category and vendor. If you select

Allow demand consolidation under these conditionsAllow demand consolidation under these conditions , you can set the criteria by procurement

category and vendor for each type of purchase requisition line. When you select a procurement

category, any subcategories for that procurement category are also selected. If you select the AllAll

option for a specific line type, all purchase requisition lines of that line type are eligible for demand

consolidation.
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Set up policy parameters

Create a new policy

This topic shows you how to create purchasing policies to align with your business processes for purchasing.

Before you can create purchasing policies, you must set up the purchasing policy parameters. It's possible to

create, modify, and retire a purchasing policy, but you can't delete a purchasing policy. This procedure would

typically be carried out by a purchasing manager. You can use this procedure in demo data company USMF or

on your own data.

1. In the navigation pane, go to Modules > Procurement and sourcing > Setup > Policies >Modules > Procurement and sourcing > Setup > Policies >

Purchasing policiesPurchasing policies .

2. On the Action Pane, select ParametersParameters .

Policy precedence rules apply to different levels in your organization. The organizational units that are shown

depend on your organizational hierarchy, and on which levels in the hierarchy have been assigned the

purpose of Procurement internal control. For example, your organization might have legal entities, cost

centers, regions, and departments, but it may be that only some of these have a hierarchy purpose of

Procurement internal control. As a default, the organization of type Company is available.

3. Select the Policy rule type parametersPolicy rule type parameters  tab.

4. In the tree, go to Purchasing policy > Purchase requisition control rulePurchasing policy > Purchase requisition control rule.

You define the order of precedence for policy resolution at the policy level. However, for some policy types,

you can override the order of precedence for individual policy rule types. For example, you might define the

order of precedence for purchasing policies to be: cost center, department, company. For the catalog policy

rule, you might want the order of precedence to be: department, cost center, company. You can change the

order of precedence for the Catalog policy rule. When a worker creates a requisition, the catalog that is

displayed is determined by the policies that are associated with the worker's department, then their cost

center, and then their company.

If there's more than one organizational level listed, you can use the Up/Down arrows to set the order of

precedence for the Purchase requisition control rule.

5. Close the page.

1. Select NewNew .

2. In the NameName field, type a value.

3. In the Descr iptionDescr iption field, type a value.

A single purchasing policy can only apply to one organization hierarchy. For example, you could have one

hierarchy called "Geographic" and one called "Department", and have a different purchasing policy for each.

Select an organization that the policy should apply to.

4. Select the arrow to add the selected organization.

You can repeat this process to add more organizations.
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1. In the Policy rule typePolicy rule type list, select Requisition purpose ruleRequisition purpose rule.

You'll create a rule that sets the default requisition purpose to type Consumption but allows the

Replenishment type to be selected instead.

2. Select Create policy ruleCreate policy rule.

3. Select YesYes  in the Allow manual overr ideAllow manual overr ide field.

4. Select CloseClose.

Now you can set up other policy rules for the purchasing policy. Note that a Policy rule type cannot have

overlapping rules that are active at the same time within a single procurement policy.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Find the procurement policy

Create a category access rule

Create a category policy rule

Use this procedure to set up rules for ordering products in a category. The rules are defined for a specific

purchasing policy. The category access rule controls which procurement categories employees have access to

when they create a requisition. When a requisition is being created, the purchasing policy and category access

rule that should be applied are determined by the legal entity and the operational unit that the employee

belongs to. You can use this procedure in demo data company USMF. This task would typically be carried out by

a purchasing manager.

1. In the Navigation pane, go to Modules > Procurement and sourcing > Setup > Policies >Modules > Procurement and sourcing > Setup > Policies >

Purchasing policiesPurchasing policies .

2. Click the link on the 'Procurement Policy USMF' policy. This is the policy that you'll add a rule to. It must be an

Active policy.

1. Expand the Policy rulesPolicy rules  fastTab.

2. In the Policy rule typePolicy rule type list, select the Categor y access policy ruleCategor y access policy rule. If the Create policy ruleCreate policy rule button is

dimmed, it's because there's already an active policy rule for Category access. Check the EffectiveEffective and

ExpirationExpiration fields to determine which it is, then select it, and click Retire policy ruleRetire policy rule. If the Create policyCreate policy

rulerule button is available, you don't need to do anything.

3. Click Create policy ruleCreate policy rule.

4. In the Effective dateEffective date field, enter a date and time. The time must not overlap with another rule that's already

active.

5. Select a category that the rule will apply to. Make a note of which category this is – you'll need it later. When

you select a category, its parent category or categories will also be added to the Selected categories list. If

you want the rule to apply to all subcategories of the selected category, select the Include subcategoriesInclude subcategories

check box.

6. Click the right arrow to add to the Selected categoriesSelected categories  list.

7. Click OKOK. If you set the Include parent ruleInclude parent rule option to Yes, the policy rule that you define for a parent

category is also assigned to its child categories, if no policy rule has been defined for the child categories.

1. In the Policy rule typePolicy rule type list, select the Categor y policy ruleCategor y policy rule. If the Create policy ruleCreate policy rule button is dimmed,

select the active policy rule, and then click Retire policy ruleRetire policy rule.

2. Click Create policy ruleCreate policy rule.

3. In the Effective dateEffective date field, enter a date and time.

4. Click AddAdd.

5. In the Categor yCategor y  field, select the same category that you used for the Categor y access ruleCategor y access rule.

6. In the Vendor selectionVendor selection field, select an option. Select a rule to control which kind of vendors can be selected

for the category when requisitions are created.

7. Click CloseClose. The policy rules that you have defined have been for requisitions of type Consumption. If you

wanted to define policies for requisitions of type Replenishment, you would create a rule for the Policy rule
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type called "Replenishment category access policy rule".
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Preregistration (ASN)

Registration

Product receipt

This topic describes the various options for registering products as received.

Product receipt is the process of recording that products that were ordered have been received, so that the

purchase order (PO) lines can then be processed for invoicing. In some cases, products go through

preregistration, where additional information from the supplier is recorded before the products are received.

When products arrive, they are first marked as RegisteredRegistered. The products might then go through additional

processes, such as quality management, before they are finally marked as ReceivedReceived.

Suppliers might share information about products that will be shipped. In this case, you can preregister the

products to record this information before the products are received. By preregistering products, you reduce the

amount of work that is required during item registration and receipt. Suppliers can provide product information

electronically through an Advance Shipment Notice (ASN) that is then automatically recorded in the system. The

information in the ASN includes the quantity of products that will be shipped and the date when they will be

shipped. The ASN might also include information such as batch or serial numbers. Registration of the ASN

occurs in the Transpor tation managementTranspor tation management module.

Product receipt registration often occurs at the inbound docks in a warehouse. It’s performed either by using a

hand-held device or through arrival journals. Alternatively, you can manually register product receipt by using

the RegistrationRegistration action on the Purchase orderPurchase order  page. In both cases, the products are marked as RegisteredRegistered.

Note that the products aren’t yet marked as ReceivedReceived.

Products that are received in a warehouse might go through quality inspection before they are put away into

inventory. Either quality orders or quarantine orders can be used to perform quality inspection. If quality orders

are used, you can configure the process to temporarily block products through a reservation while they are

inspected. If quarantine orders are used, products are moved to another warehouse for inspection. This

warehouse is known as the quarantine warehouse. In both quality inspection processes, some of the goods

might be scrapped, either because they don’t conform to the quality expectations or because the quality

inspection involves destructive testing of a sample of the product.

Most often, the Product receiptProduct receipt action on the Purchase ordersPurchase orders  page is used to mark products as ReceivedReceived

on the PO. The Posting product receiptPosting product receipt page has various options for the quantity that is accounted as

received. For example, you can set the QuantityQuantity  field to Ordered quantityOrdered quantity  or Receive now quantityReceive now quantity .

Alternatively, if a warehouse arrival process has been used, you will often set this field to Registered quantityRegistered quantity .

You can modify the quantities on each order line that will be marked as ReceivedReceived, to account for any

discrepancies, such as under-delivery and over-delivery. During product receipt, you must specify a product

receipt identifier, which is typically a reference to the packing slip from the supplier. This identifier is required for

accounting, because it enables checks or audits of supplier packing slips against what has been received, and the

accounted inventory or expense.

POs can be created for products that aren’t intended as inventory but are considered an expense. This category

includes order lines where the products are marked as Not stockedNot stocked by their inventory model group, and also
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lines that use procurement categories. In this case, the items might not go through arrival registration and

receipt in the warehouse. Instead, the Product receiptProduct receipt action is used to record the receipt directly on the PO,

and the receipt is based on the ordered quantity, not a registered quantity.

You can create PO lines where the New fixed assetNew fixed asset option is enabled. This option indicates that the purchase

should be considered a fixed asset instead of inventory. In this case, the fixed asset determination rules that have

been configured determine whether the purchase of the product or category exceeds specific thresholds, and

must therefore be accounted for as an asset and go through fixed asset management. Purchases can also be

made toward an existing fixed asset. In this case, the amount is adjusted as appropriate.

You can select multiple orders and process receipt on all those orders together. This approach isn’t used very

often, but you might want to use it if a supplier has consolidated shipments for you into a single load. During

product receipt on the purchase, there is a function for doing summary updates. Summary updates let you post

a single packing slip from the supplier for more than one PO.

POs might be created from a sales order where the Direct deliver yDirect deliver y  option was selected. When direct delivery

is used, the products never arrive in your warehouse but are shipped directly from the supplier to the customer.

In this case, the receipt is usually recorded directly on the PO. The receipt can be done automatically, such as

through electronic data interchange (EDI) integration with the supplier. Alternatively, if the PO is an

intercompany PO, Supply Chain Management automates the receipt on the intercompany sales order when

shipment occurs. When direct delivery is used, products are still accounted as inventory, even though they don’t

physically arrive at the warehouse. Therefore, when product receipt is registered on the PO, the sales order is

automatically updated with a packing slip, so that the overall change to inventory is 0 (zero). In direct delivery

scenarios, you should not require preregistration. If you’re using warehouses that are enabled for warehouse

management, you can get around the requirement for license plate registration by specifying a virtual

warehouse instead. You specify this warehouse in the Direct deliver y warehouseDirect deliver y warehouse field on the product.

After the product receipt has been processed on the PO, the PO status is set to ReceivedReceived to indicate that the

invoice can be processed for the order. You can review details about products that have already been received by

using the Product receipt journalsProduct receipt journals  page.

You can access this page from the ReceiptReceipt action group on the Purchase orderPurchase order  page. The information in the

journals includes details about the quantities, dates, and dimensions.

Purchase order overview

Create purchase orders

Approve and confirm purchase orders

Overview of vendor invoices
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Vendor invoices

Understanding invoice line quantities

This topic provides general information about vendor invoices. Vendor invoices are requests for received

payment for products and services. Vendor invoices might represent a bill for ongoing services, or they can be

based on purchase orders for specific items and services.

A vendor invoice from a purchase order is produced when products or services are received according to a

purchase order placed with a vendor. The vendor invoice contains a header, and one or more lines for items or

services. A vendor invoice completes the cycle from purchase order to product receipt to vendor invoice.

Although some vendor invoices connect to a purchase order, vendor invoices can also contain lines that don't

correspond to purchase order lines. You can also create vendor invoices that aren't associated with any purchase

order. These vendor invoices might represent ongoing services, such as a utility bill. You don't have to reference

a purchase order when you add an ongoing service.

There are several ways to enter a vendor invoice:

The vendor invoice register lets you quickly enter invoices that don't reference a purchase order, so that you

can accrue the expense. By using the vendor invoice approval journal, you can select those invoices and post

them to the vendor balance to reverse the accrual.

The vendor invoice journal lets you quickly enter invoices that don't reference a purchase order, in a single

step.

Together with the vendor invoice pool, the vendor invoice register lets you quickly enter invoices to accrue

the expense. You can open the associated purchase orders later to post the invoice against the expense

account.

The Open vendor invoicesOpen vendor invoices  and Pending vendor invoicesPending vendor invoices  pages let you create vendor invoices from

confirmed purchase orders.

The following discussion provides more information about how to use the Open vendor invoicesOpen vendor invoices  or PendingPending

vendor invoicesvendor invoices  page to create a vendor invoice from a purchase order.

When you open a vendor invoice from a related purchase order, the system creates invoice lines from the

purchase order. By default, the system takes the quantities from the product receipt. However, you can use any of

the following default behaviors:

Receive now quantityReceive now quantity  – Use this option for partial shipments. The system sets the default value in the

QuantityQuantity  from the quantity specified in the Receive nowReceive now  field on the purchase order.

Ordered quantityOrdered quantity  – Use this option for complete shipments. The system sets the default value in the

QuantityQuantity  from the quantity specified in the OrderedOrdered field on the purchase order.

Registered quantityRegistered quantity  – Use this option if the item requires registration, as specified on the Item modelItem model

groupsgroups  page. The default value in the QuantityQuantity  field is the physical update quantity that has been

registered.

Product receipt quantityProduct receipt quantity  – Use this option if a product receipt has already been received for the order. The

system takes the default value in the QuantityQuantity  field from the total quantity of available product receipts.

Registered quantity and ser vicesRegistered quantity and ser vices  – Use this option if quantities have been registered in arrival journals
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Adding a line that wasn't on the purchase order

Submitting a vendor invoice for review

Preventing invoice from being submitted to workflowPreventing invoice from being submitted to workflow

Matching vendor invoices to product receipts

for stocked items or items that aren't stocked. This option also includes services, regardless of whether they

are registered.

If your legal entity uses invoice matching, you can view the results of the quantity matching in the ProductProduct

receipt quantity matchreceipt quantity match column. You can also use the Matching detailsMatching details  button on the ReviewReview  tab of the

Action Pane to view the results of the quantity matching.

You can add a line that wasn't on the purchase order to the vendor invoice. You must select an item number or

procurement category. You can then add quantities, prices, and amounts to the line. The line will be included

only in matching policies for invoice totals.

Your organization might use workflows to manage the review process for vendor invoices. Workflow review can

be required for the invoice header, the invoice line, or both. The workflow controls apply to the header or the

line, depending on where the focus is when you select the control. Instead of the PostPost button, a SubmitSubmit button

displays send the vendor invoice through the review process.

Following are several ways you can prevent an invoice from being submitted to a workflow.

Invoice total and the registered total are not equal.Invoice total and the registered total are not equal. The person who submitted the invoice will

receive an alert that the totals aren’t equal. The alert provides an opportunity to correct the balances

before resubmitting the invoice to workflow. This feature is available if the Prohibit submission toProhibit submission to

workflow when the invoice total and registered invoice total are not equalworkflow when the invoice total and registered invoice total are not equal  parameter on the

Feature managementFeature management page is turned on.

Invoice contains unallocated charges.Invoice contains unallocated charges. The person who submitted the invoice will receive an alert

that the invoice has unallocated charges so they can correct the invoice before resubmitting it to

workflow. This feature is available if the Prohibit submission to workflow when there areProhibit submission to workflow when there are

unallocated charges on a vendor invoiceunallocated charges on a vendor invoice parameter on the Feature managementFeature management page is turned

on.

Invoice contains the same invoice number as another posted invoice.Invoice contains the same invoice number as another posted invoice. The person who

submitted the invoice will receive an alert that an invoice with a duplicate number was found, and they

can correct it before resubmitting to workflow. This alert will be displayed when the Check the invoiceCheck the invoice

number usednumber used parameter in Accounts payable is set to Reject duplicateReject duplicate. This feature is available if the

Prohibit submission to workflow when the invoice number already exists on a postedProhibit submission to workflow when the invoice number already exists on a posted

invoice, and your system is not set up to accept duplicate invoice numbersinvoice, and your system is not set up to accept duplicate invoice numbers  parameter on the

Feature managementFeature management page is turned on.

You can enter and save information for vendor invoices, and you can match invoice lines to product receipt lines.

You can also match partial quantities for a line.

You can create a vendor invoice that is based on the product receipt line items that have been received through

the current date, even if all the items for a particular purchase order haven't yet been received. For example, you

might use this option if a vendor sends one invoice per month to cover all the deliveries that it shipped during

that month. Each product receipt represents a partial or complete delivery of the items on the purchase order.

When an invoice is in workflow, the approver can update invoice quantities so that they match the value in the

Product-receipt-quantity-to-matchProduct-receipt-quantity-to-match field. To do so, select the Update the invoice quantities to matchUpdate the invoice quantities to match



Configure an automated task for vendor invoice workflow to post the
vendor invoice using a batch job

Working with multiple invoices

Recovering vendor invoices that are being used

product receipt quantities in workflowproduct receipt quantities in workflow  feature in the Feature managementFeature management workspace and select

EnableEnable. If an approver in the workflow process has removed all the matches from all the product receipts from

the invoice line, the invoice line will be deleted. When this feature isn't enabled, invoice quantities are not

updated for invoices in workflow.

When you post the invoice, the Invoice remainderInvoice remainder  quantity for each item is updated with the total of the

received quantities from the selected product receipts. If both the Invoice remainderInvoice remainder  quantity and the DeliverDeliver

remainderremainder  quantity for all items on the purchase order are 0 (zero), the status of the purchase order is changed

to InvoicedInvoiced. If the Invoice remainderInvoice remainder  quantity isn't 0, the status of the purchase order remains unchanged,

and additional invoices can be entered for it.

This option assumes that at least one product receipt has been posted for the purchase order. The vendor

invoice is based on these product receipts and reflects the quantities from them. The financial information for

the invoice is based on the information that is entered when you post the invoice.

For more information, see Record vendor invoice and match against received quantity.

You can add an automated posting task to the Vendor invoice workflow so that invoices are processed in a

batch. Posting invoices in a batch lets the workflow process continue without having to wait for the posting to

finish, which improves the overall performance of all the tasks submitted to the workflow.

To post a vendor invoice in a batch, on the Feature managementFeature management page, turn on the Vendor invoice batchVendor invoice batch

postingposting parameter. Vendor invoice workflows are configured by going to Accounts payable > Setup >Accounts payable > Setup >

Accounts payable workflowsAccounts payable workflows .

You can see the Post the vendor invoice using a batchPost the vendor invoice using a batch task in the workflow editor, regardless of whether the

feature parameter, Vendor invoice batch postingVendor invoice batch posting, is enabled. When the feature parameter is not enabled, an

invoice that contains the Post the vendor invoice using a batch taskPost the vendor invoice using a batch task won't process in workflow until the

parameter is enabled. The Post the vendor invoice using a batchPost the vendor invoice using a batch task must not be used in the same

workflow as the Post vendor invoicesPost vendor invoices  automated task. Also, the Post the vendor invoice using a batchPost the vendor invoice using a batch

task should be the last element in the workflow configuration.

You can specify the number of invoices to include in the batch, and the number of hours to wait before

rescheduling a batch, by going to Accounts payable > Setup > Accounts payable parameters > InvoiceAccounts payable > Setup > Accounts payable parameters > Invoice

> Invoice workflow> Invoice workflow .

You can work with multiple invoices at the same time and post all of them at the same time. If you need to create

multiple invoices, use the Pending vendor invoicesPending vendor invoices  page. If you must post and print multiple vendor invoices,

use the invoice approval journal. If you're using the invoice approval journal, at least one product receipt must

be posted for the purchase order, and an invoice for the purchase order must be posted in an invoice register.

The financial information for the invoice comes from the invoice that was posted in the register.

While a vendor invoice is being used, it can't be edited by another user. However, the state of an invoice might

sometimes indicate that the invoice is being used, even though it isn't being actively edited. For example, the

application might have stopped responding while the invoice was being edited, or a user might have

inadvertently left the invoice open in the application.

You can use the Recover vendor invoicesRecover vendor invoices  page to recover or release vendor invoices that have been in use for

https://docs.microsoft.com/en-us/dynamics365/finance/accounts-payable/tasks/record-vendor-invoice-match-against-received-quantity
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Viewing the invoice total on the Pending vendor invoices page
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more than four hours, so that they can be edited. You can open this page from the Periodic taskPeriodic task navigation or a

tile on the Vendor invoice entr yVendor invoice entr y  workspace. After an invoice is recovered, it will be available for editing on the

Vendor invoiceVendor invoice page.

You can access the Recover vendor invoicesRecover vendor invoices  page only if the Recover vendor invoices in useRecover vendor invoices in use security duty

and privilege are assigned to you. Additionally, the Allow vendor invoice recover yAllow vendor invoice recover y  parameter on the

Accounts payable parametersAccounts payable parameters  page must be turned on.

A workflow instance that has stopped because of an unrecoverable error will have a workflow status of

UnrecoverableUnrecoverable. When the status of a vendor invoice workflow is UnrecoverableUnrecoverable, you can reset it to DraftDraft by

selecting RecallRecall . You can then edit the vendor invoice. This feature is available if the Resetting the workflowResetting the workflow

status for vendor invoices from Unrecoverable to Draftstatus for vendor invoices from Unrecoverable to Draft parameter on the Feature managementFeature management page

is turned on.

You can use the Workflow histor yWorkflow histor y  page to reset the workflow status to DraftDraft. You can open this page from

Vendor invoiceVendor invoice or from the Common > Inquires > WorkflowCommon > Inquires > Workflow  navigation. To reset the workflow status to

DraftDraft, select RecallRecall . You can also reset the workflow status to Draft by selecting the RecallRecall  action on the

Vendor invoiceVendor invoice or Pending vendor invoicesPending vendor invoices  page. After the workflow status is reset to DraftDraft, it becomes

available for editing on the Vendor invoiceVendor invoice page.

You can view the invoice total on the Pending vendor invoicesPending vendor invoices  page by enabling the Display invoice totalDisplay invoice total

on pending vendor invoices liston pending vendor invoices list parameter on the Accounts payable parametersAccounts payable parameters  page.

Set up vendor invoice policies

Key invoice data in AP system using vendor invoice

Key invoice data into accounts payable using an approval journal

Key invoice data into the AP system using invoice pool

Record a vendor invoice in the invoice journal

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/finance/accounts-receivable/tasks/set-up-vendor-invoice-policies
https://docs.microsoft.com/en-us/dynamics365/finance/accounts-payable/tasks/key-invoice-data-ap-system-vendor-invoice
https://docs.microsoft.com/en-us/dynamics365/finance/accounts-payable/tasks/key-invoice-data-into-ap-system-approval-journal
https://docs.microsoft.com/en-us/dynamics365/finance/accounts-payable/tasks/key-invoice-data-into-ap-system-invoice-pool
https://docs.microsoft.com/en-us/dynamics365/finance/accounts-payable/tasks/record-vendor-invoice-invoice-journal
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I can't post more than one invoice for a purchase order line that has
category-based items.

I receive an "Object reference not set" error during purchase order
confirmation, or an "Exception has been thrown by the target of an
invocation" exception occurs during vendor invoice posting.

I can't consolidate multiple product receipts into a single purchase
order.

When product receipts are canceled, transactions can be posted to a
suspended ledger account.
Issue descriptionIssue description

Reproduce the issueReproduce the issue

This topic describes how to fix issues that you might encounter while you work with product receipts and

invoicing.

A quantity is mandatory if you want to post invoices. Therefore, if the full quantity of a line has been invoiced for

only a partial amount, you won't be able to invoice the remaining amount on another invoice.

This issue can occur because of inconsistency in purchase order distributions.

To unblock this issue and reset the purchase order to a Draft state, go to Procurement and sourcing >Procurement and sourcing >

Periodic tasks > Clean up > Purchase order distr ibution resetPeriodic tasks > Clean up > Purchase order distr ibution reset. For more information, see the following

blog post: Resolve PO distribution errors in Dynamics 365 Supply Chain Management.

You can't consolidate multiple product receipts into a single purchase order if the different product receipt lines

have different accounting dates.

In earlier versions of Microsoft Dynamics 365 Supply Chain Management, consolidation was allowed in this

situation. However, the practice is prone to error. The accounting date on the purchase order lines that are

created should not differ from the accounting date on the product receipt lines that those purchase order lines

were created from. (The accounting date on the purchase order lines matches the accounting date on the

purchase order header.) Therefore, the consolidation of multiple product receipts into a single purchase orders is

no longer allowed.

The accounting date is used, for example, for budget reservations and encumbrance. Therefore, it should be kept

during the transition from product receipt to purchase order.

If a product receipt is canceled, the system allows transactions to be posted to suspended ledger accounts, even

though the main accounts are suspended.

The following procedure shows one way to reproduce the issue.

1. On the Accounts payable parametersAccounts payable parameters  page, on the GeneralGeneral  tab, make sure that the Post productPost product

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/troubleshooting-productreceiptinvoicing.md
https://cloudblogs.microsoft.com/dynamics365/it/2020/08/12/resolve-po-distribution-errors-in-dynamics-365-supply-chain-management/


Issue resolutionIssue resolution

A product receipt voucher number is consumed even if no financial
voucher is generated during product receipt.

The Post to charge account in ledger setting isn't turned on.
Issue descriptionIssue description

Reproduce the issueReproduce the issue

receipt in ledgerreceipt in ledger  option is set to Yes.

2. Create a purchase order, and add an order line that has a quantity of 1,000 for a product.

3. Confirm the purchase order.

4. Post the product receipt, and check the vouchers.

5. Suspend the relevant main accounts, 200140 and 140200.

6. Cancel the posted product receipt.

7. Notice that transactions can be posted to the suspended leger accounts.

Transactions can be posted to the suspended leger accounts when product receipts are canceled, because this

behavior allows for correct postings.

If the Accrue liability on product receiptAccrue liability on product receipt option is set to No for the item model group, no postings to the

general ledger will occur. However, a physical event will be recorded for the purpose of accounting in a

subledger, and that event requires a voucher number. This voucher number is the voucher number that is

referenced in the inventory transactions.

We recommend that you set the Accrue liability on product receiptAccrue liability on product receipt option to Yes, as described in the

following blog post: Post Misc. charges at time of product receipt.

This issue occurs when a purchase order is invoiced, if the Post to charge account in ledgerPost to charge account in ledger  option is set to

Yes on the InvoiceInvoice tab of the Accounts payable parametersAccounts payable parameters  page.

The following procedure shows one way to reproduce the issue.

1. Go to Accounts payable > Setup > Accounts payable parametersAccounts payable > Setup > Accounts payable parameters .

2. On the InvoiceInvoice tab, set the Post to charge account in ledgerPost to charge account in ledger  option to Yes.

3. Go to Inventor y management > Setup > Posting > PostingInventor y management > Setup > Posting > Posting.

4. On the Purchase orderPurchase order  tab, make sure that you've deleted all the lines in the purchase expenditure for

the product.

5. Go to Accounts payable > Purchase orders > All purchase ordersAccounts payable > Purchase orders > All purchase orders .

6. Create a purchase order. In the Vendor accountVendor account field, select 1001 Acme Office Supplies.

7. Add a purchase order line that has the following settings:

Item number :Item number : D0011 Laser Projector

Site:S ite: 1

Warehouse:Warehouse: 11

Quantity:Quantity: 4

8. On the Action Pane, on the PurchasePurchase tab, in the ActionAction group, select ConfirmConfirm .

9. On the Action Pane, on the ReceiveReceive tab, in the GenerateGenerate group, select Product receiptProduct receipt.

10. In the Posting product receiptPosting product receipt dialog box, in the Product receiptProduct receipt field, enter an arbitrary number, and

https://cloudblogs.microsoft.com/dynamics365/no-audience/2014/11/11/post-misc-charges-at-time-of-product-receipt/
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then select OKOK.

11. On the Action Pane, on the InvoiceInvoice tab, in the GenerateGenerate group, select InvoiceInvoice.

12. In the NumberNumber  field, enter an arbitrary number as the invoice number.

13. Update the match status, and post.

14. Notice that you now receive the following error when you generate an invoice from a purchase order :

"Account number for transaction type Purchase expenditure for product does not exist."

This depends on the parameter settings for invoices and invoice groups. For more information, see the following

blog post: Accounting for Purchase charge and Stock variation.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://cloudblogs.microsoft.com/dynamics365/no-audience/2014/12/15/accounting-for-purchase-charge-and-stock-variation/
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Set up vendor collaboration security roles

Set up the security roles that are available for selection when a new user request is used for a contact personSet up the security roles that are available for selection when a new user request is used for a contact person

NOTENOTE

Vendor admin (external) security roleVendor admin (external) security role

The vendor collaboration interface exposes a limited set of information about purchase orders, invoices, and

consignment stock to external vendor users. From this interface, a vendor can also reply to requests for

quotation (RFQs), and view and edit basic company information.

This topic explains how to set up vendor collaboration in Dynamics 365 Supply Chain Management. It also

explains how to set up a workflow to provision new vendor collaboration users, and how to manage the security

roles for those users.

The information about the setup of security roles for vendor collaboration applies only to the current version of Finance

and Operations. In Microsoft Dynamics AX 7.0 (February 2016) and Microsoft Dynamics AX application version 7.0.1

(May 2016), you collaborate with vendors by using the Vendor por talVendor por tal module. For information about user permissions

for the Vendor portal in Microsoft Dynamics AX, see Vendor portal user security.

A procurement professional or a vendor that has enough permissions can request that a contact person be

provisioned as a user by enabling Provision vendor userProvision vendor user  on the contact person record. During the

provisioning process, user permissions are selected for the new external user, and the new vendor user request

is submitted. It's important that you correctly set up the user permissions that are available for selection in the

vendor user request. Otherwise, vendors might be granted access to information that they should not have

access to in Supply Chain Management.

1. Select System administrationSystem administration > SecuritySecurity  > External rolesExternal roles .

2. Select NewNew , and then select a security role and the VendorVendor  party role.

You might want to add the Vendor admin (external)Vendor admin (external)  and Vendor (external)Vendor (external)  roles that are provided in

Supply Chain Management. Alternatively, you can use security roles that your company has created.

You should make the Vendor admin (external)Vendor admin (external)  role available only if vendors should be able to create new

contacts, submit vendor collaboration user requests for new users and changes to user information, and handle

those requests via a workflow.

If you plan to manually set up vendor contacts and users, you can make just the Vendor (external) roleVendor (external) role

available. This role will then be the only role that can be requested through a vendor user request.

The SystemUserSystemUser  role is automatically granted when you manually create a new user account. Therefore, you must

remove that role and assign the SystemExternalUserSystemExternalUser  role. If new user accounts are created via the workflow that is

initiated by a vendor user request to provision a new user, one or more of the roles that you've set up for vendor

collaboration and the SystemExternalUserSystemExternalUser  role will be assigned.

The Vendor admin (external)Vendor admin (external)  role can be used for external vendors that maintain vendor contact information

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/set-up-maintain-vendor-collaboration.md
https://docs.microsoft.com/en-us/dynamics365/supply-chain/procurement/configure-security-vendor-portal-users


 

Vendor (external) security roleVendor (external) security role

Set up security roles that are used when prospective vendors are
onboarded

Set up a security role that is used when a new prospective vendor user request is submittedSet up a security role that is used when a new prospective vendor user request is submitted

Set up workflows to process vendor collaboration user requests

and make requests to provision new vendor collaboration users. External users who have this security role can

perform the following tasks:

View and modify contact person information, such as the person's title, email address, and telephone number.

Add a new or existing contact person to the vendor accounts that they are a contact for.

Delete any contact person that they have created.

Activate or inactivate the association between a contact person and a vendor account. After the association

between a contact person and a vendor account is inactivated, the contact person can't be referred to on new

purchase orders or other documents.

Deny or allow a contact person's access to documents on the vendor collaboration interface that are specific

to the vendor account. After the association between a contact person and a vendor account is inactivated,

access to documents that are specific to the vendor account is always denied.

Request a new user account for a contact person by using the Provision userProvision user  action.

Request that a contact person's user account be inactivated.

Request that a contact person's user account be modified to add or remove security roles.

View RFQs.

The Vendor (external) roleVendor (external) role can be used for external vendors that will work with purchase orders. External

users who have this security role can perform the following tasks:

Respond to and view information about purchase orders.

Maintain vendor collaboration invoices.

View consignment inventory.

View and respond to RFQs.

View vendor information.

To onboard vendors that are initiated via a prospective vendor registration request, you must set up an external

security role. This role will be assigned to new users during the provisioning process that is controlled by the

workflow of the User request workflow (platform)User request workflow (platform)  type. For more information, see the Set up workflows to

process vendor collaboration user requests section later in this topic.

For information about how to onboard prospective vendors, see Onboard vendors.

1. Select System administrationSystem administration > SecuritySecurity  > External rolesExternal roles .

2. Select NewNew , and then select a security role and the Prospective vendorProspective vendor  party role.

You should add the Vendor prospect (external)Vendor prospect (external)  role that is provided in Supply Chain Management.

The security role will grant access only to the new vendor registration wizard.

To help guarantee that all the relevant tasks are completed, and that the appropriate approvals are given, you

must set up workflows to handle vendor collaboration user requests.

Vendor collaboration user requests are submitted either by external vendors that have the Vendor adminVendor admin

(external)(external)  security role or similar permissions, or by procurement professionals in your company. They can also

be generated from prospective vendor registration requests during the vendor onboarding process.



Example of a workflow for provisioning new users and modifying security rolesExample of a workflow for provisioning new users and modifying security roles

Branch to provision new usersBranch to provision new users

Branch to modify security rolesBranch to modify security roles

Example of a workflow for inactivating a userExample of a workflow for inactivating a user

There are three types of requests:

Requests to provision a new user

Requests to inactivate an existing user

Requests to modify the security roles of an existing user

For more information about vendor collaboration user requests, see Manage vendor collaboration users.

You must create two or more workflows to process all three types of vendor collaboration user requests. New

workflows are created on the User workflowsUser workflows  page.

To handle vendor user requests to create new users and modify security roles, you can put a branching

condition at the beginning of the workflow. In this way, a different branch of the workflow is used, depending on

whether the request is to create a new user or modify an existing user.

To set up this branching, create a new workflow of the User Request Workflow (Platform)User Request Workflow (Platform)  type. The

branches of this workflow might contain the following elements.

NOTENOTE

1. Assign an approval task to the person who is responsible for approving that new users should be granted

access to vendor collaboration information.

2. Assign a task to the person who is responsible for requesting new Microsoft Azure Active Directory

(Azure AD) user accounts in Azure portal. Use the predefined Send Azure B2B user invitationSend Azure B2B user invitation task for

this step. B2B users can be automatically exported to Azure AD. Use the predefined Provision Azure ADProvision Azure AD

B2B userB2B user . For more information, see Export B2B users to Azure AD.

3. Assign an approval task to the person who uploads to Azure. If an account isn't successfully created, this

person rejects the task and ends the workflow. This approval task can be skipped if you've included the

step that automatically exports new user accounts to Azure via the B2B application programming

interface (API).

4. Add an automated task that provisions a new user. Use the predefined Automated provision userAutomated provision user  task

for this step.

5. Add a task that notifies the new user. You might want to send the new user a welcome email that includes

a URL for Supply Chain Management. This email can use a template that you create on the EmailEmail

messagesmessages  page and then select on the User workflow parametersUser workflow parameters  page. The template can include the

%por tal URL%%por tal URL% tag. When the welcome email is generated, this tag which will be replaced by the URL of

the Supply Chain Management tenant.

This workflow can be used in multiple scenarios that involve user onboarding. For example, it can be used when

prospective vendors or contact persons require a vendor collaboration account. Therefore, you should phrase the

email as a general statement that can be used for multiple purposes.

1. Assign an approval task to the person who is responsible for approving changes to security roles.

2. Add an automated task that adds or removes the relevant security roles. Use the Automated provisionAutomated provision

useruser  task for this step.

Create a workflow of the Inactivate user request workflow platformInactivate user request workflow platform type, and then add the following tasks.

1. Assign an approval task to the person who is responsible for accepting requests to inactivate users. You can

file:///T:/eiye/ac1a/dynamics365/dev-itpro/sysadmin/implement-b2b.html
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add conditions to automate this approval step.

2. Add an automated task that inactivates the user. Use the Automated user inactivationAutomated user inactivation task for this step.

3. Add any clean-up tasks that are required. For example, you can add a task that removes the account from

your directory in Azure portal.

Before you create a user account for someone who will use vendor collaboration, you must set up the vendor so

that it can use vendor collaboration. On the VendorsVendors  page, on the GeneralGeneral  tab, set the CollaborationCollaboration

activationactivation field. The following options are available:

Active (PO is auto-confirmed)Active (PO is auto-confirmed)  – Purchase orders are automatically confirmed if the vendor accepts them

without requesting changes.

Active (PO is not auto-confirmed)Active (PO is not auto-confirmed)  – Your organization must manually confirm purchase orders after the

vendor has accepted them.

Procurement professionals in your company can also complete this task.

New vendor collaboration users are provisioned via the workflow that you set up to process vendor

collaboration user requests of the Provision vendor userProvision vendor user  type.

If the email address of a new vendor collaboration user belongs to a domain that is registered with Azure as a

tenant (that is, if it's a managed domain account), the email address must be an existing Azure AD account.

Otherwise, the provisioning process can't be completed.

For more information about the process that is used in the Send Azure B2B user invitationSend Azure B2B user invitation task in the

workflow for Azure AD account management, see Azure Active Directory B2B collaboration.

Vendor collaboration with external vendors

Watch a short video on the vendor onboarding process: Onboard a new vendor

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://azure.microsoft.com/documentation/articles/active-directory-b2b-collaboration-overview/
https://www.youtube.com/watch?v=0KUc3AGaTKk&feature=youtu.be
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Add new vendor collaboration contacts

Vendor collaboration user requests

This topic describes how you can request the provisioning of new vendor collaboration users, and how to add

new vendor collaboration contacts.

The vendor collaboration interface in Dynamics 365 Supply Chain Management exposes information about

purchase orders, invoices, and consignment stock to external vendors. You can create new vendor collaboration

contacts and request that new users are provisioned if you're working as an external vendor with the VendorVendor

admin (external)admin (external)  security role, or similar permissions. You can also perform these tasks if you're working as a

procurement professional. In this topic, this role refers to a procurement professional who is working within the

company that owns the instance of Supply Chain Management. For more information about how to use vendor

collaboration if you're an external vendor, see Vendor collaboration with customers.

For more information about how to use vendor collaboration if you're a procurement professional, see Vendor

collaboration with external vendors.

If you want someone to have access to vendor collaboration they first have to be added as a vendor

collaboration contact. You may also want to add contacts for employees in your company who won't use vendor

collaboration. For example, they could be the point of contact for other kinds of procurement information. New

contacts are added on the All contactsAll contacts  page, which is accessed from the Vendor collaborationVendor collaboration > ContactsContacts

menu. To add a new contact:

1. Click New.New.

2. Enter the contact person details.

3. Choose which legal entity they're representing in your company, and which legal entity they'll work with in

the company that they'll collaborate with. You do this by selecting a Legal entity in my companyLegal entity in my company/LegalLegal

entity in customer companyentity in customer company  pair.

4. Click Create.Create.

If you want to delete a contact, it's only possible to delete the ones that you've created.

Vendor collaboration user requests can be raised by a procurement professional, or by an external vendor

administrator.

If you're an external vendor, you submit requests from the All contactsAll contacts  page within the VendorVendor

collaborationcollaboration module.

If you're a procurement professional, you submit requests from the View contactsView contacts  page. To do this, on the

vendor record, in the SetupSetup section on the Action Pane, select ContactsContacts  > View contactsView contacts .

You can make a request to provision a user, to inactivate a user, or to modify security roles. If you're an external

vendor administrator, you must be registered as a contact person for the vendor accounts that you want to

make user requests for, and you must have access to the vendor collaboration interface for those vendor

accounts.

When a request is submitted it is added to the Vendor collaboration user requestsVendor collaboration user requests  list in the VendorVendor

collaborationcollaboration module, and to the Vendor collaboration user requestVendor collaboration user request list in the Procurement andProcurement and

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/manage-vendor-collaboration-users.md


Provision a userProvision a user

Inactivate a userInactivate a user

Modify security rolesModify security roles

sourcingsourcing module (the Procurement and sourcing module is not accessible to external users).

Before you can request that a new user is provisioned, that person must be set up as a contact for one or more

vendor accounts. To create a request for a new vendor collaboration user :

1. On the All contactsAll contacts  page, click Provision vendor userProvision vendor user .

2. Enter an email address for the user. This address will be used by the user to sign in to Supply Chain

Management. If the email address belongs to a domain registered as a tenant with Microsoft Azure, then the

email address has to be an existing Azure Active Directory (AAD) account in order for the provisioning

process to complete successfully. If the email address does not belong to a domain registered with Microsoft

Azure, an AAD account will be created as part of the provisioning process and the new user will receive an

invitation mail. Consumer email addresses with domains such as @hotmail.com, @gmail.com, or

@comcast.net cannot be used to register a user.

3. Set the Vendor collaboration access allowedVendor collaboration access allowed option to YesYes  for all the legal entities that the user needs

access to.

4. In the Assign user rolesAssign user roles  section, select the AssignAssign check box for the security roles that the new user should

have.

5. Click SubmitSubmit.

When the vendor user request is submitted, the Vendor collaboration access allowedVendor collaboration access allowed field is set to YesYes  for

the selected vendor account and a user request workflow is started. As part of the workflow, a new user is

created, and security roles are assigned. In addition, an Azure B2B service is activated which initiates interaction

with Azure portal and associates a new or existing AAD account with the Supply Chain Management user

account. For more information, see What is Azure AD B2B collaboration?.

There are two ways to remove access to vendor collaboration for a user :

On the ContactsContacts  page for the vendor, set the Vendor collaboration access allowedVendor collaboration access allowed option to NoNo for the

contact. This can be done individually per legal entity that the person is a contact for. This option can only be

used by procurement professionals.

Inactivate the entire user account, by submitting an Inactivate vendor userInactivate vendor user  request.

To request that a user is inactivated:

1. On the All contactsAll contacts  page, click InactivateInactivate vendor uservendor user .

2. Write a comment in the Business justificationBusiness justification field.

3. Click SubmitSubmit.

The Maintain vendor user rolesMaintain vendor user roles  page is the same as the Provision vendor userProvision vendor user  page except that the list of

security roles can be edited.

To request that the security roles are modified for a user :

1. On the All contactsAll contacts  page, click MaintainMaintain vendor user rolesvendor user roles .

2. Write a comment in the Business justificationBusiness justification field.

3. In the Maintain user rolesMaintain user roles  section, select the security roles that you want to assign, or clear the ones that

you want to remove.

4. Click SubmitSubmit.

https://docs.microsoft.com/en-us/azure/active-directory/active-directory-b2b-what-is-azure-ad-b2b
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Vendor account numbers

Vendor organizations and individual vendors

Addresses

This topic describes the types of information that you must specify when you create a new vendor account.

When you create a vendor account, you enter information about the vendor. This information is used to

automatically enter data in documents and to track activity that involves the vendor. For example, you can

configure the following information for a vendor:

Assign a vendor group. Every vendor must be assigned to a vendor group. The vendors in a vendor group

have parameters that they share. For example, they might have the same terms of payment.

Configure the vendor for catalog import. Vendors can provide a file that contains the catalog of their items

and services. This file can be uploaded so that your workers can order from the vendor.

Assign the vendor to procurement categories.

Allow an existing vendor to do business with another legal entity in your organization.

Put a vendor on hold for specific types of transactions.

Set up banking information for the vendor, so that you can send payments electronically.

Set up tax, delivery, invoice, and payment information for the vendor. By default, these settings are copied to

new documents that you create for the vendor.

Set up default financial dimensions that are used to automatically post transactions with the vendor to

financial accounts.

To speed up the process of creating vendor accounts, you can create templates. To create a template, on the

VendorVendor  page, on the Action Pane, click OptionsOptions  > Record infoRecord info. Then click Company accounts templateCompany accounts template.

Company account templates are shared with other users.

You can also create a user template for your own use. You can't delete a vendor that is associated with other

records, such as contacts or products.

The account number is a unique identifier for a vendor. You can set up account numbers so that they're

generated automatically when you create a vendor. You can also configure the number sequence so that account

numbers are entered manually. For example, you might want to use the vendor’s telephone number as the

identifier.

When you create a new vendor account, you must select whether the vendor is an organization or a person.

Your selection affects the information that you must fill in for the vendor. For a person, this information includes

the first name, last name, and title. For an organization, this information includes the organization number and

the number of employees.

For each vendor, you can define multiple addresses, each of which is used for a different purpose. For example,

you can create an address that has a purpose of InvoiceInvoice. Or, if you will pay the vendor by using checks, you can

set up an address that has a purpose of Remit-toRemit-to. If you must specify an address to use for money transfers to

foreign banks, the purpose will be SWIFTSWIFT.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/set-up-vendor-accounts.md


Vendor contacts

Vendors in different legal entities

Agreements

Putting a vendor on hold

You can store contacts for a vendor. These contacts can then be used on documents such as purchase orders or

requests for quotation (RFQs).

To add contacts for a vendor, on the All vendorsAll vendors  page, on the VendorVendor  tab, in the Set upSet up group, click ContactsContacts

> Add contactsAdd contacts .

You can create vendor contacts from scratch. Alternatively, you can copy details from another person who is

already registered in Supply Chain Management, and edit the information as you require.

Note:Note: Adding a contact for a vendor isn't the same as adding contact information for that vendor. Although you

might add general contact information for a vendor, you might also have several specific people who are

contacts at that company, and who all have their own contact information.

You can't delete a contact person record if the contact is referenced on a document. Instead, you can inactivate

the contact.

You can add vendor contacts to your personal contacts in Microsoft 365. However, you must first set up

synchronization between Supply Chain Management and Microsoft 365 in both Microsoft Exchange Server

synchronization and the Microsoft Outlook setup wizard.

If a vendor is registered for only one legal entity in your organization, and other legal entities must register the

same vendor, you can use the Add vendor to another legal entityAdd vendor to another legal entity  page to configure the vendor to do

business with another legal entity. You must select a vendor group, currency, and hold status for the vendor in

the selected legal entity.

If multiple legal entities in your organization do business with the same vendor, and each legal entity maintains

a separate vendor account for that vendor, you can merge the party IDs for the vendor accounts. In this way,

information such as the address and the number of employees can be shared, so that you must update it in only

one place.

To merge party IDs, follow these steps.

1. On the Global address bookGlobal address book page, select the address book records that represent the vendor in each legal

entity that should be included in the mapping.

2. On the Action Pane, click Merge recordsMerge records .

When you set up a vendor account, you might also want to register the agreements that you have with the

vendor. You can set up price and discount agreements by using the actions on the vendor record. You can also

set up a purchase agreement on the Purchase agreementsPurchase agreements  page.

You can put a vendor on hold for various transaction types. The following options are available:

NoNo – No holds have been put on the vendor.

InvoiceInvoice – No invoices can be posted for the vendor.

AllAll  – The vendor is on hold for all transaction types. These transaction types include purchase requisitions,

invoices, and payments.

PaymentPayment – No payments can be generated for the vendor.

RequisitionRequisition – Purchase requisitions can't be created for the vendor, and requisition lines already created



Vendor invoice account

Vendor bank accounts

Ledger accounts

before the vendor was set on hold can't be converted to a purchase order. Requisition lines for the vendor

will be canceled if your policy is set to create purchase orders automatically.

NeverNever  – The vendor is never put on hold for inactivity.

When you put a vendor on hold, you can also specify a reason and a date when the on-hold status will end. If

you don't enter an end date, the vendor's on-hold status lasts indefinitely.

You can bulk update the on-hold status to AllAll  for vendors based on the selected criteria on the VendorVendor

inactivationinactivation page, and assign a reason for why the vendor is on-hold.

The following criteria are used to include vendors that have been inactive in a period, include or exclude vendors

that are employees, and exclude vendors that are under a grace time before the next hold.

Based on the number of days that you enter in the In activity per iodIn activity per iod field on the Vendor inactivationVendor inactivation

page, the application calculates the latest date where the vendor can have any activity to be considered

inactive. That is, the current date minus the number of days that you enter. If one or more invoices exist for

the vendor where the date is later than the calculated latest date, the vendor will be excluded from the

inactivation. This is also validated if the vendor has payments after that date, open purchase requisitions,

open purchase orders, requests for quotations, or replies.

The number of days in the Grace time before next holdGrace time before next hold field is used to calculate the latest grace date. That

is, the current date minus the days that you enter. This only applies to vendors who have previously been

inactivated. In the case of a previous inactivation, the application verifies the history of other occurrences of

inactivation for the vendor and checks if the latest inactivation occurred before the latest grace date. If this is

the case, the vendor will be included in the inactivation process.

The parameter Include employeesInclude employees  refers to vendors that are linked to an employee. You can set if you want

to include those employees.

This process will always exclude vendors where the value in the Vendor holdVendor hold field is NeverNever .

Vendors that pass the validations are put on-hold, which sets the Vendor holdVendor hold field value to AllAll  and the

ReasonReason to what has been selected. A record in the on-hold history is created for the vendor.

If more than one vendor has the same billing address, or if a vendor is invoiced through a third party, you can

specify an invoice account on the vendor record. The invoice account is the account that the invoice amount is

credited to when you create a vendor invoice from a purchase order. If you don't enter an invoice account on the

vendor record, the vendor account is used as the invoice account.

If you must make payments to a vendor bank account, you can enter information about the vendor’s bank and

bank accounts on the Vendor bank accountsVendor bank accounts  page. You can also enter information about validation and

payments for the bank account. For example, you can add prenotes to vendor bank accounts. These prenotes

can be used to verify the accuracy of account data, such as routing numbers and account numbers. You must

specify a default account for payments to the vendor. However, when you make an actual payment, you can

change this account to one of the vendor's other accounts.

You can specify the default accounts that automatically appear in vendor invoice journals for the specified

vendor. This functionality can be useful if you typically pay for the same types of items or services from the

same vendors over time. When you specify a default account, you can quickly and efficiently enter journal

entries in the invoice journal. The default accounts that you specify aren't used for purchase orders, or for

vendor invoices that are entered on the Vendor invoiceVendor invoice page.



NOTENOTE

You select default accounts on the Default account setupDefault account setup page, which you can open from the InvoiceInvoice tab on

the vendor record. The accounts that you select here appear in the filtered list of accounts for the vendor

account when you enter a journal entry. You can set one of the accounts as a default account.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a vendor account

Add an address

Add contact information

This procedure shows how to create a vendor account, and add an address and contact information. The

procedure does not show how to populate all fields for purchasing and financial purposes. To learn more about

those fields, please read the field descriptions. You can use this procedure in demo data company USMF or on

your own data. Vendor accounts are typically created by a procurement professional or accounts receivable

personnel.

1. Go to Navigation pane > Modules > Procurement and sourcing > Vendors > All vendorsNavigation pane > Modules > Procurement and sourcing > Vendors > All vendors .

2. Click NewNew .

3. In the Vendor accountVendor account field, type a value.

4. In the NameName field, enter or select a value. If your vendor is an already a registered party in your system you

can use drop down and select them in this field and the new vendor account will inherit the address and

contact information that's already registered.

5. In the GroupGroup field, enter or select a value. The vendor group is used to group vendors that have any of the

following parameters in common: Terms of payment, settle period, inventory posting ledger accounts –

including the sales tax group, default ledger accounts, product filter codes, or supply forecast configuration.

6. In the Number of employeesNumber of employees  field, enter a number.

7. In the Organization numberOrganization number  field, type a value.

The value may be populated automatically. If so, you can skip this step.

You can create vendor accounts for a person or organization. This will affect which fields are available.

In this example, we'll create a vendor account for an organization.

1. Expand the AddressesAddresses  section.

2. Click AddAdd.

3. In the PurposePurpose field, enter or select a value. You can select one or more purposes. These are used to select

the correct address for a given purpose. For example, if the purpose is "Invoice" that address will be used

when you send invoices.

4. In the Name or descr iptionName or descr iption field, type a value.

5. In the Countr y/regionCountr y/region field, enter or select a value. Enter the address details. The country/region that you

selected will determine the fields you are presented with, corresponding to the address format for the

country/region.

6. Click OKOK.

1. Expand the Contact informationContact information section.

2. Click AddAdd.

3. In the Descr iptionDescr iption field, type a value.

4. In the TypeType field, select an option.

5. In the Contact number/addressContact number/address  field, type a value. You can select the Primary check box if this is the

primary contact.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/tasks/create-vendor-account.md
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6. Click SaveSave.

7. Close the page.

8. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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This procedure shows you how to create a bank account for a vendor. You can use this procedure in demo data

company USMF.

1. Go to Navigation pane > Modules > Procurement and sourcing > Vendors > All vendorsNavigation pane > Modules > Procurement and sourcing > Vendors > All vendors .

2. Select the vendor that you want to create a bank account for, and then click the link on the Vendor accountVendor account

IDID field.

3. On the Action PaneAction Pane, click VendorVendor .

4. Click Bank accountsBank accounts .

5. On the Action PaneAction Pane, click NewNew .

6. In the Bank accountBank account field, type a value. This ID will be used to identify the bank account on the vendor

record.

7. In the NameName field, type a value.

8. In the Bank groupsBank groups  field, enter or select a value.

9. In the Routing number typeRouting number type field, select an option. This is the type of routing number that's used for

international payments.

10. In the Bank account numberBank account number  field, type a value.

11. In the SWIFT codeSWIFT code field, type a value.

12. In the IBANIBAN field, type a value.

13. Expand the SetupSetup section.

14. In the Text codeText code field, type a value. This field specifies a code that will appear on the bank statement of the

recipient.

15. In the Message to bankMessage to bank field, type a value.

16. In the Exchange referenceExchange reference field, type a value. This is the reference number for any forward-term or fixed-

term rate of exchange.

17. In the CurrencyCurrency  field, enter or select a value. When prenotes are issued, this section provides an overview of

their status (pending or approved).

18. Expand the AddressAddress  section.

19. Expand the PrenotesPrenotes  section.

20. Expand the Contact informationContact information section.

21. In the TelephoneTelephone field, type a value.

22. Close the page.

23. Click EditEdit.

24. Expand the PaymentPayment section.

25. In the Bank accountBank account field, select the account that you've just created.

26. Click SaveSave. The address may be inherited from the bank group, if one is specified, or you can add it here.

The IBAN number must be in the correct format. For example, you could use

DE89370400440532013000.

The status of the bank account is Active if the Active date has been reached, and the Expiration date

has not been exceeded. It's also active if both the Active date and Expiration date fields are blank. If the

dates in both the Active date and Expiration date fields are in the future electronic payments are not

available. Other payment types are available and the bank account is active.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/tasks/create-vendor-bank-account.md
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Vendor posting profiles

Creating a posting profile
SetupSetup

A C C O UN T  C O DEA C C O UN T  C O DE  F IEL D VA L UE F IEL D VA L UE
A C C O UN T / GRO UP  N UM B ERA C C O UN T / GRO UP  N UM B ER  F IEL D F IEL D
VA L UEVA L UE SEA RC H  P RIO RIT YSEA RC H  P RIO RIT Y

TableTable Specific vendor account 1

GroupGroup Vendor group that is assigned to the
vendor

2

AllAll Blank 3

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Posting profilePosting profile Enter a code for the posting profile. For example, you could
create two posting profiles to obtain one account for vendor
balances in the national currency and another for vendor
balances in a foreign currency. You could call one account
National and the other Foreign.

DescriptionDescription Enter a description of the posting profile.

Vendor posting profiles control the posting of vendor transactions to the general ledger.

Vendor posting profiles enable you to assign general ledger accounts and document settings to all vendors, a

group of vendors, or a single vendor. These settings will be used when you create purchase orders, vendor

invoices, and cash payments. For some transactions, you can select a posting profile that differs from and takes

precedence over the posting profiles that are set up for transactions on this page. The default posting profile is

defined on the Ledger and Sales TaxLedger and Sales Tax FastTab on the Accounts payable parametersAccounts payable parameters  page. The default

posting profile is then included automatically on the header of new documents where you can change it to a

different posting profile, if needed.

You can also associate posting definitions with transaction posting types on the Transaction postingTransaction posting

definitionsdefinitions  page. Posting definitions control the posting of vendor transactions to the general ledger instead of

posting profiles.

Specify the ledger accounts that are used in the posting of transactions that use the selected posting profile.

Select an account code and, whenever possible, an account or group number for the selected posting profile. In

the posting process, the most appropriate posting profile for each transaction is located by searching for the

most specific account code, account number, or group and number combination in the following priority.

If you want all vendor transactions to have the same posting profile, set up only one posting profile with AllAll  in

the Account codeAccount code field. Specify the following values to set up your posting profile.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/accounts-payable/vendor-posting-profiles.md


Account codeAccount code Specify whether the posting profile applies to a specific
vendor, a group of vendors, or all vendors:

Account/Group numberAccount/Group number If TableTable is selected in the Account codeAccount code field, select the
account number of the vendor that is associated with the
posting profile. If GroupGroup is selected, select a vendor group. If
AllAll is selected, leave this field blank.

Summar y accountSummar y account Select the ledger account that will be used as the summary
account for the vendors that the posting profile relates to.
The Do not allow manual entr yDo not allow manual entr y  parameter for this main
account will be marked. If you subsequently remove this
account from the posting profile, validate the Do not allowDo not allow
manual entr ymanual entr y  setting on the Main accountsMain accounts page.

Settle accountSettle account Select the liquidity ledger account that is used for cash flow
forecasts. This fields is only available when cash flow
forecasting is enabled.

Sales tax prepaymentsSales tax prepayments Select the account for sales tax payments that are received in
advance.

ArrivalArrival Select the ledger account that information about
unapproved vendor invoices is posted to. The information is
entered in the Invoice register journal. For example, a user
enters very basic information about vendor invoices when
they are received in the invoice register. When the invoice
register is posted, the transactions are posted to the account
that is entered here and in the Offset accountOffset account  field. When
the invoices are approved, the debt is transferred from the
arrival account to the vendor summary account.

Offset accountOffset account Select the ledger account that is used for offsetting
unapproved vendor invoices that are updated by using the
invoice register. The offset account acts as the offset account
for transactions that are posted to arrival accounts.
Therefore, the account contains vendor purchases that have
not yet been approved.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

TableTable – The posting profile applies to a single vendor.
Select the vendor account in the Account/GroupAccount/Group
numbernumber  field.

GroupGroup – The posting profile applies to a vendor
group. Select the vendor group in the
Account/Group numberAccount/Group number  field.

AllAll – The posting profile applies to all vendors. Leave
the Account/Group numberAccount/Group number  field blank.

Note:Note:  If the Use posting definitionsUse posting definitions option is
selected on the General ledger parametersGeneral ledger parameters  page, the
transaction posting definition for vendor invoices is used
instead of the summary account.

Note:Note:  The posting profile that is used when the
payment is marked as a prepayment is selected in the
PostingPosting profile with Prepayment journal voucherPrepayment journal voucher
field in the Ledger and sales taxLedger and sales tax area on the
Accounts payable parametersAccounts payable parameters  page.



Table restrictionsTable restrictions

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

SettlementSettlement Select this option to enable automatic settlement of
transactions that have this posting profile. If this option is
cleared, you must manually settle transactions by using the
Settle open transactionsSettle open transactions page.

CancelCancel Select this option if you want to be able to cancel
transactions that have this posting profile.

CloseClose Select a posting profile to change to when transactions that
have this posting profile are closed. A transaction is regarded
as closed when it has been settled in full.

NOTENOTE

For transactions that have the selected posting profile, specify whether transactions will be settled automatically,

interest will be calculated, and collection letters will be issued. You can also select the account that is used when

transactions that have the selected posting profile are closed.

Specify the following values to set up your posting profile

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Set up a vendor request configurationSet up a vendor request configuration

Create a vendor configuration for a specific country/regionCreate a vendor configuration for a specific country/region

NOTENOTE

To complete a vendor request, a vendor contact person must complete the prospective vendor registration

wizard.

In the Vendor request configurationsVendor request configurations  form, you can create profiles that specify required fields and visible

fields in the prospective vendor registration wizard.

The vendor registration wizard will start out by asking the prospective vendor user which country/region the

vendor is doing business in. This information determines the applicable configuration. If no specific

configuration is defined for a country/region, a default configuration will be used.

By default, there is a vendor configuration available in the Vendor request configurations form.

It is not possible to select country/regions for the default configuration, so the Countr ies/regionsCountr ies/regions  section

cannot be changed.

1. Click Procurement and sourcingProcurement and sourcing > SetupSetup > VendorsVendors , and then click Vendor request configurationsVendor request configurations .

2. Click the FieldsFields  tab to set the status of the listed fields.

3. Hidden (Not visible)

4. Displayed (Visible but not mandatory)

5. Required (Visible and mandatory)

6. Click the ContentContent tab to specify if text is going to be shown on the wizard and if there should be an

acknowledgement that the prospective vendor user must accept this before moving to the next step in the

wizard. The acknowledgement will be requested for any terms and conditions that the user must accept to

continue.

You can also enter a confirmation message that will be displayed when the wizard is finalized, and you can add

one or more questionnaires.

1. Click Procurement and sourcingProcurement and sourcing > SetupSetup > VendorsVendors , and then click Vendor request configurationsVendor request configurations .

2. Click NewNew  to create a new configuration, and provide a name for the configuration.

3. Click SaveSave.

4. Open the Countr y/regionsCountr y/regions  tab to select the country/region that the configuration should be used for.

5. Complete the configuration by following the guidelines for the default configuration.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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System The request
for a new
vendor is
imported.

After the
vendor
request is
accepted, the
vendor record
is created.

Procurement
professional

Start the
onboarding
process.

Review and
either accept
or reject the
vendor
request.

New vendors can be onboarded and registered as vendors in Microsoft Dynamics 365 Supply Chain

Management, based on information that is collected from a person who represents the vendor.

The process consists of the following steps, where various roles perform actions in the system.

1. Data management ODataData management OData – Entity import - The initial request is the prospective vendor registration

request. Typically, this request comes from a source such as a customer-hosted website that allows

anonymous access. Vendors can sign up by providing basic information, such as the vendor name,

justification, organization number, and name and email address of the contact person. The requests are

imported via the Data management interface.

2. Prospective vendor registration request list pageProspective vendor registration request list page - Based on the information that is provided in the

prospective vendor registration request, a procurement professional decides whether the vendor should be

onboarded. The procurement professional views the incoming request on the Prospective vendorProspective vendor

registration requestsregistration requests  list page.

3. User provisioning workflowUser provisioning workflow  - When a procurement professional has verified the information in the

incoming request and has decided to continue with the onboarding process, the user request workflow

provisions the new user and sends an invitation email to accept the contact person as an authenticated user

of Microsoft Dynamics 365.

4. Vendor registration wizardVendor registration wizard - The vendor's contact person signs in by using the new user account. He or

she completes a vendor registration wizard to provide information such as addresses, business information,

procurement categories, and questionnaire responses.

5. Approval workflowApproval workflow  - A vendor request that includes the registration information is created. This vendor

request is submitted to a workflow, and is routed for review and approval.

6. Creation of a vendor master and user role modificationCreation of a vendor master and user role modification - When the vendor request is approved, a

vendor record is created. The user account of the vendor's contact person is either granted permission to

vendor collaboration or inactivated.

The following table shows the steps and roles that are involved in the process.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/vendor-onboarding.md
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Importing the prospective vendor registration request

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Vendor name The name of the vendor.

Business justification The reason or reasons for the vendor request.

Organization number An officially known registration number.

Line of business The line of business that the vendor is in.

Contact person's first name The first name of the person who will be invited to register
vendor information.

Contact person's middle name The middle name of the person who will be invited to
register vendor information.

Contact person's last name The last name of the person who will be invited to register
vendor information.

Contact person's email The email address that will be used to create a new user in
Supply Chain Management, and that will be registered in the
tenant's Azure Active Directory (Azure AD) account.

Submitted date The date when the request was created in an external
system.

For a quick demonstration of the vendor onboarding process, watch this short YouTube video about How to

onboard a new vendor in Finance and Operations.

The prospective vendor registration request is an entity in Supply Chain Management. You can set up the system

to import data via this entity.

The following table shows the information that this entity contains, and that can be imported.

https://www.youtube.com/watch?v=0KUc3AGaTKk


Legal entity The legal entity where the vendor is requesting to become a
vendor. This value must be a legal entity code that has been
registered in Supply Chain Management. If no value is
received though the import process, a value from the
Procurement and sourcing parameters is applied.

Vendor type The vendor can be either an organization or a person. The
vendor type determines how the vendor is finally created.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Submitting a prospective vendor user request

Vendor registration

PA GEPA GE DESC RIP T IO NDESC RIP T IO N

Country/region The country or region determines the vendor request
configuration that is applied on the remaining wizard pages.
It also determines values in the Tax stateTax state lookup.

Terms and conditions This page might be available, depending on the vendor
request configuration. If it's available, the user must
acknowledge the terms and conditions to continue.

After the prospective vendor registration request is imported, it appears on the Prospective vendorProspective vendor

registration requestregistration request list page. From this list page, a procurement professional can invite the user. A user

request for provisioning the user is sent to a workflow.

The purpose of a prospective vendor user request is to provision the person who submitted the initial request,

so that he or she can sign in to Supply Chain Management by using the email account that is provided in the

prospective vendor registration request.

The prospective vendor user request is processed by the user request workflow. This workflow communicates

through Azure AD B2B collaboration. It creates a user in Supply Chain Management that has the appropriate

security settings.

New users that are set up have the following security roles:

System external user

Vendor prospective (external)

The new user will receive an email that is generated by the user request workflow. This email invites the user to

sign in to the system.

For information about the configuration of the email and the workflow in general, see the description of a user

request workflow in Set up and maintain vendor collaboration.

A prospective vendor user who signs in to Supply Chain Management will see the first page of a vendor

registration wizard, where he or she can enter vendor information.

The wizard reflects the configuration of the vendor request. The country or region where the vendor does

business determines what information is requested in the wizard and what information is mandatory.

For more information about the vendor request configuration, see Set up and maintain vendor collaboration.

The following table gives an overview of the pages in the wizard and the purpose of each page.



Vendor information This page contains the vendor name, which is automatically
entered from the original prospective vendor registration
request. It also contains the organization number, the
vendor's telephone number, fax number, and email address,
and the vendor's addresses for various purposes.

Contact person information This page contains the contact person's name, which is
automatically entered from the original prospect vendor
registration request. It also contains the contact person's
telephone number and email address, and the contact
person's addresses for various purposes.

Business information This page contains tax registration numbers (for various
countries or regions) and the numbers of employees. It also
indicates whether the business is minority owned.

Procurement categories This page contains the procurement categories that the
vendor is requesting approval for. The user can select
categories in the procurement category hierarchy. You can
configure the number of levels that are shown in the
hierarchy at Procurement and sourcing parametersProcurement and sourcing parameters  >
Vendor collaborationVendor collaboration, under Procurement andProcurement and
sourcingsourcing > SetupSetup.

Questionnaires The wizard might include a set of questionnaires for the
vendor. Questionnaires that appear in the wizard are
configured either on the vendor request or per procurement
category. If questionnaires are configured per procurement
category, the procurement categories that the vendor
requests approval for determine the questionnaires that
appear in the wizard. On the Procurement categoriesProcurement categories
page, you can add a questionnaire under the relevant
category and set the activity type to Vendor onboardingVendor onboarding.

PA GEPA GE DESC RIP T IO NDESC RIP T IO N

Manually or automatically submit a vendor request

Vendor requests

When the prospective vendor user completes the vendor registration wizard, a vendor request is created.

A vendor request can be created as a draft and manually submitted to a workflow. Alternatively, the vendor

request can be automatically submitted to a workflow when the vendor registration wizard is completed. A

request can be submitted manually if, for example, a procurement professional wants to assess whether the

request should be routed through an approval process before it's submitted to the workflow.

Select Procurement and sourcing parametersProcurement and sourcing parameters  > Vendor collaborationVendor collaboration, and then select Auto submitAuto submit

prospective vendor registration to workflowprospective vendor registration to workflow  to configure the vendor request so that it's submitted

automatically to a workflow when the vendor registration wizard is completed.

Vendor requests are available on the Vendor collaboration user requestsVendor collaboration user requests  page.

A vendor request contains the information that the prospective vendor user entered in the vendor registration

wizard.

The request lets you review the vendor information and decide whether the vendor should become a registered

vendor.



STAT USSTAT US DESC RIP T IO NDESC RIP T IO N

Draft The vendor request hasn't yet been submitted.

Request submitted The vendor request has been submitted, and the first step in
the workflow is being processed.

Pending review If there are multiple reviewers in a workflow task, a reviewer
can accept the task of reviewing the vendor request and
then complete the review. If there is only one reviewer, that
participant can complete the review by selecting
CompletedCompleted in the workflow action. He or she doesn't have
to accept the work item first.

Request pending approval The vendor request has been routed to the participants for
approval, and there is an option to request additional
information. A request for additional information cause the
work item to be routed back to the submitter. The vendor
request can also be approved or rejected while it's in this
status.

Application change request Additional information has been requested by the approver,
and the vendor request has been routed to the person who
submitted the vendor request. The submitter can add
required information and then resubmit the vendor request.
If a vendor request is resubmitted, the status is changed
back to Request pending approvalRequest pending approval status.

Request approved This status is a final state.

Request rejected This status is a final state.

Approving a vendor request

The vendor request should be submitted to a workflow, and it should be routed to the relevant reviewers and

approvers. For basic information about how to set up workflows, see Procurement and sourcing workflows.

The following table shows the statuses that vendor requests can have.

When a vendor request is approved, a vendor account is created, and the status ApprovedApproved appears on both the

initial prospective vendor registration request and the vendor request.

Before you approve a vendor request, on the New vendorNew vendor  page, on the GeneralGeneral  FastTab, select Vendor groupVendor group

to select a vendor group.

If the prospective vendor user should have access to Supply Chain Management as a vendor collaboration user

who represents the vendor, set the vendor collaboration access permission to YesYes . To inactivate the user account

that the prospective vendor used to register, set this permission to NoNo.

If the vendor collaboration access permission is set to YesYes , when the vendor request is approved, a request is

submitted to modify the user's roles so that the user has the roles that are defined for the VendorVendor  type in

External rolesExternal roles . If this permission is set to NoNo, when the vendor request is approved, a request is submitted to

inactivate the user. In this case, the workflow to inactivate a user request must be set up.

For a vendor account to be created when the vendor request is approved, the number sequence for creating

vendors from vendor requests must be set to AutoAuto.

For an overview of the access permissions of a vendor collaboration user, see Set up and maintain vendor



Rejecting a vendor request

Deleting a prospective vendor registration request in various statuses

STAT USSTAT US STAT US DESC RIP T IO NSTAT US DESC RIP T IO N RESULT  O F  T H E DEL ET E  A C T IO NRESULT  O F  T H E DEL ET E  A C T IO N

New No actions have been taken on the
request.

The prospective vendor registration
request is deleted.

User requested When you select Invite userInvite user , the
status is changed to User requestedUser requested,
and a prospective user request is
created and submitted to a user
request workflow.

You can't delete a prospective vendor
registration request that has this
status, because the user request
workflow hasn't ended.

User invited The user request workflow is approved,
and the user is created.

A request to inactivate the user is
created, and the prospective vendor
registration request is deleted.

Registration in progress The new user has signed in and has
started the vendor registration wizard.

A request to inactivate the user is
created, and the prospective vendor
registration request and the data that
was entered in the vendor registration
wizard are deleted.

Vendor request created The vendor registration wizard has
been completed.

A request to inactivate the user is
created, and the prospective vendor
registration request, the data that was
entered in the vendor registration
wizard, and the vendor request are
deleted.

[!NOTE]
You can't use the DeleteDelete action
when the vendor request is in a
review process in the workflow.

Approved The vendor request is approved. The prospective vendor registration
request, the data that was entered in
the vendor registration wizard, and the
vendor request are deleted.

collaboration.

If a vendor request is rejected, a reason for rejection must be selected in the vendor request.

When a vendor request is rejected, a request is submitted to inactivate the user. In this case, the workflow to

inactivate a user request must be set up. For more information, see Set up and maintain vendor collaboration.

When a vendor request is rejected, the status RejectedRejected appears on both the initial prospective vendor

registration request and the vendor request.

The various statuses of a prospective vendor registration request give an overview of the request's progress.

By using the DeleteDelete action on the prospective vendor registration request, you can clean up and remove the

chain of records that has been created, and you can inactivate the user account. The result of the DeleteDelete action

varies, depending on the status of the prospective vendor registration request, as shown in the following table.



Rejected The vendor request is rejected. The prospective vendor registration
request, the data that was entered in
the vendor registration wizard, and the
vendor request are deleted.

STAT USSTAT US STAT US DESC RIP T IO NSTAT US DESC RIP T IO N RESULT  O F  T H E DEL ET E  A C T IO NRESULT  O F  T H E DEL ET E  A C T IO N
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Defining the information that is shown to vendors when they respond
to POs

Setting the vendor collaboration options for a specific vendor

The Vendor collaborationVendor collaboration module is targeted at vendors who don't have electronic data interchange (EDI)

integration with Microsoft Dynamics 365 Supply Chain Management. It lets vendors work with purchase orders

(POs), invoices, consignment inventory information, and requests for quotation (RFQs), and also lets them

access parts of their vendor master data. This topic explains how you can collaborate with external vendors who

use the vendor collaboration interface to work with POs, RFQs, and consignment inventory. It also explains how

to enable a specific vendor to use vendor collaboration, and how to define the information that all vendors see

when they respond to a PO.

For more information about what external vendors can do in the vendor collaboration interface, see Vendor

collaboration with customers.

The information about vendor collaboration in this topic applies only to the current version of Supply Chain Management.

In Microsoft Dynamics AX 7.0 (February 2016) and Microsoft Dynamics AX application version 7.0.1 (May 2016), you

collaborate with vendors by using the Vendor por talVendor por tal module. For information about the Vendor por talVendor por tal module, see

Collaborate with vendors by using the Vendor portal.

For more information about how vendors can use vendor collaboration in invoicing processes, see Vendor

collaboration invoicing workspace. For information about how to provision new vendor collaboration users, see

Manage vendor collaboration users.

When vendors respond to a PO that you send them, they see one of three message boxes, where they must

confirm that they want to accept the PO, reject it, or accept it with changes. Because the information that must be

shown to the vendor at that point might be specific to your business, you can specify the text that appears in

each confirmation message. For example, the text can inform the vendor about the next steps in the process, or

about terms and conditions.

To define the text that's shown in the PO response, follow these steps

1. On the Information for vendors responding to POsInformation for vendors responding to POs  page, select the response type, and then select EditEdit.

2. In the Information messageInformation message box, enter the information that should be shown to vendors in the message

box.

If you must add messages in more than one language, create separate messages, and specify the appropriate

language code for each. The message that is shown to each vendor will be in the language that the vendor uses.

An administrator configures the general settings for vendor collaboration, such as the security roles that are

available for all vendors that you collaborate with. However, there are also settings that can differ for each

vendor account. You should configure these settings.

Enable vendor collaboration.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/vendor-collaboration-work-external-vendors.md
https://docs.microsoft.com/en-us/dynamics365/supply-chain/procurement/collaborate-vendors-vendor-portal
file:///T:/eiye/ac1a/dynamics365/financials/accounts-payable/vendor-portal-invoicing-workspace.html


Enabling vendor collaborationEnabling vendor collaboration

Specifying whether the vendor should see price informationSpecifying whether the vendor should see price information

Working with POs when vendor collaboration is used
Sending a PO to a vendorSending a PO to a vendor

Confirmation and acceptance of a PO by a vendorConfirmation and acceptance of a PO by a vendor

VEN DO R RESP O N SEVEN DO R RESP O N SE RESULTRESULT

The vendor acceptsaccepts the order, and Supply Chain
Management is configured to automatically confirm POs
that the vendor accepts.

The status of the order is updated to ConfirmedConfirmed. If the
order can't be updated for some reason, the vendor
response is still recorded as AcceptedAccepted, but the status of the
PO remains In External ReviewIn External Review.

The vendor acceptsaccepts the order, but Supply Chain
Management isn't configured to automatically confirm POs
that the vendor accepts.

The vendor response is recorded as AcceptedAccepted, but the
status of the PO remains In External ReviewIn External Review.

Specify whether the vendor should see price information.

Before user accounts can be created for an external vendor, you must configure the vendor account so that

vendor can use vendor collaboration. On the VendorsVendors  page, on the GeneralGeneral  tab, set the CollaborationCollaboration

activationactivation field. The following options are available:

Active (PO is auto-confirmed)Active (PO is auto-confirmed)  – POs are automatically confirmed if the vendor accepts them without

changes.

Active (PO is not auto-confirmed)Active (PO is not auto-confirmed)  – Your organization must manually confirm POs after the vendor has

accepted them.

To share price information for POs via the vendor collaboration interface, you must set the Purchase orderPurchase order

prices/amountprices/amount option on the Purchase order defaultsPurchase order defaults  tab for the vendor account to YesYes . This price

information includes the unit price, discounts, and charges.

POs are prepared in Supply Chain Management. When a PO has a status of ApprovedApproved, you send it to the

vendor by selecting Send for confirmationSend for confirmation on the Purchase orderPurchase order  page. The PO status is then changed to InIn

External ReviewExternal Review . After the PO has been sent, the vendor can see it on the Purchase orders for reviewPurchase orders for review  page

in the vendor collaboration interface. The vendor can then accept the PO, reject it, or suggest changes to it. The

vendor can also add comments to communicate information such as changes to the PO. If you want to draw the

vendor's attention to a new PO, you can also use the Print management system to send the PO by email.

After a vendor accepts a PO, the PO can be automatically confirmed, or it might have to be manually confirmed.

The behavior depends on whether the Collaboration activationCollaboration activation field is set to Active (PO is auto-Active (PO is auto-

confirmed)confirmed)  or Active (PO is not auto-confirmed)Active (PO is not auto-confirmed)  for the vendor.

The following table shows the typical exchange of information, depending on the vendor's response when you

send a PO for confirmation.

The PO that was sent to the vendor and that has a
status of In External ReviewIn External Review is updated with confirmed
delivery dates on the lines. This update initiates a new
version that is automatically set to ConfirmedConfirmed status.
When the PO is confirmed, it appears in the vendor
collaboration interface.

The PO that was sent to the vendor and that has a
status of In External ReviewIn External Review is updated with confirmed
delivery dates on the lines. This update initiates a new
version that is automatically set to In External ReviewIn External Review
status. You can then manually confirm the PO.



The vendor rejectsrejects  the order. The vendor response is recorded as RejectedRejected, and the
status of the PO remains In External ReviewIn External Review. The rejection
is received together with the vendor's note.

The vendor acceptsaccepts the order with changeswith changes . Changes are
suggested at the line level. The vendor can accept or reject
individual lines. Here are some other changes that the
vendor can suggest:

The vendor can't change price information and charges.
However, the vendor can suggest these changes by using
notes.

The vendor response is recorded as Accepted withAccepted with
changeschanges , and the status of the PO remains In ExternalIn External
ReviewReview. The statuses show the types of changes that the
vendor has suggested. For information about the automatic
consumption of changes, see the "Update the PO when a
vendor suggests changes" section later in this topic.

VEN DO R RESP O N SEVEN DO R RESP O N SE RESULTRESULT

Changing a POChanging a PO

Canceling a POCanceling a PO

Adding attachments to a POAdding attachments to a PO

Updating a PO when a vendor suggests changes

Change dates or quantities.

Split lines for different delivery dates or quantities.

Substitute an item.

You can use the Purchase order preparationPurchase order preparation workspace to monitor which POs the vendor has responded to.

This workspace contains two lists that contain POs that have a status of In External ReviewIn External Review :

In external review requires action

In external review awaiting vendor response

To change a PO that a vendor has already responded to, you must send the vendor a new version of the PO. The

new PO will have a version suffix to indicate that it's a modified version of a PO that was previously sent. The

Purchase order vendor confirmation histor yPurchase order vendor confirmation histor y  page lets you and your vendors track the history of each

order. The previously confirmed version of a PO remains in the list of confirmed POs until the new PO has been

confirmed.

When you cancel a PO, the status is changed to ApprovedApproved. You must send the PO back to the vendor, so that the

vendor can confirm or reject the cancellation. After the cancellation is confirmed, the PO appears in the vendor's

list of confirmed POs as CancelledCancelled.

You can add attachments such as files, images, and notes to the PO by using the document management system.

Attachments of the ExternalExternal  type will be visible to the vendor when you send the PO.

If a vendor has responded to a PO and suggested changes, the next step is to process the response.

In the Purchase order preparationPurchase order preparation workspace, in the In external review requires actionIn external review requires action list, you can

identify POs that a vendor has accepted with changes. From this list, you can also navigate to the vendor's

response.

On a response, a vendor can change the following information on the header :

Vendor document reference

Mode of delivery

Delivery terms

Confirmed delivery date

The vendor can also add a note or attachment.



PO statuses and versions

Versions and statuses if you don't use change managementVersions and statuses if you don't use change management

A C T IO NA C T IO N STAT US A N D VERSIO NSTAT US A N D VERSIO N

The initial version of the PO is created in Supply Chain
Management.

The status is ApprovedApproved.

The PO is sent to the vendor. A version is registered in the vendor collaboration interface,
and the status is changed to In External ReviewIn External Review.

The vendor sends an Accepted with changesAccepted with changes response. The status is still In External reviewIn External review.

You make some changes that the vendor requested. The state is changed to ApprovedApproved.

You send the new version of the PO to the vendor. A new version is registered in the vendor collaboration
interface, and the status is changed to In External ReviewIn External Review.

On the lines, the vendor can change the quantity and the delivery dates, add notes and attachments, reject a line,

substitute a line with another product that is entered as text, and split a line into multiple deliveries. The status of

a line varies, depending on the changes that the vendor has suggested:

Accepted with changesAccepted with changes

RejectedRejected

SubstitutedSubstituted – In this case, an extra line is added that has a status of SubstituteSubstitute.

ConfirmedConfirmed

Split into scheduleSplit into schedule – In this case, extra lines are added that have a status of Schedule linesSchedule lines .

If a line has no changes, the line status is AcceptedAccepted.

On the response, the line statuses tell you the types of changes that the vendor made. Additionally, all fields that

were changed appear bold to help you identify the changes.

You can update a PO by selecting Process PO updateProcess PO update on the response or on one line at a time. An Is POIs PO

update processed?update processed? field on the header and the lines indicates whether the system has processed the header

or lines to update the PO with changes that originate from the response. You can run the Process PO updateProcess PO update

action only one time per header or line.

Not all suggested changes can be updated on a PO. Only updates on the header, and updates of dates and

quantities on lines, can be automatically updated on the PO. For other changes, you must manually update the

PO. In this case, the value of the Is PO update processed?Is PO update processed? field is Manual updateManual update. For example, if a vendor

suggests that a line be split into a schedule, this change must be made manually.

Every line that has a status of AcceptedAccepted will have a confirmed delivery date. When you run the Process POProcess PO

updateupdate action, this date is updated on the PO. Notes and attachments aren't automatically transferred to the

current PO. Additionally, trade agreements aren't reassessed on the PO lines when you update the current PO

via the Process PO updateProcess PO update action.

This section describes the various statuses that a PO can have up to the time when it's confirmed. It also

describes when new versions of a PO are made available to the vendor. The behavior varies, depending on

whether you use change management for POs.

The following table shows an example of the changes in status and version that a PO might go through.



The vendor accepts the new version of the PO. The status is still In External ReviewIn External Review, unless the vendor
account is configured to automatically set POs to
ConfirmedConfirmed status when the vendor accepts them.

A C T IO NA C T IO N STAT US A N D VERSIO NSTAT US A N D VERSIO N

NOTENOTE

Versions and statuses if you use change managementVersions and statuses if you use change management

A C T IO NA C T IO N STAT US A N D VERSIO NSTAT US A N D VERSIO N

The initial version of the PO is created in Supply Chain
Management.

The status is DraftDraft .

The PO is submitted to the approval process. (The approval
process is an internal process that the vendor isn't involved
in.)

The status is changed from DraftDraft  to In ReviewIn Review to
ApprovalApproval if the PO isn't rejected during the approval
process. The approved PO is registered as a version.

The PO is sent to the vendor. The version is registered in the vendor collaboration
interface, and the status is changed to In External ReviewIn External Review.

You make some changes that the vendor requested, either
manually or by using the Process PO updateProcess PO update action on
the response to update the PO.

The status is changed back to DraftDraft .

The PO is submitted to the approval process again. The status is changed from DraftDraft  to In ReviewIn Review to
ApprovalApproval if the PO isn't rejected during the approval
process. Alternatively, the system can be configured so that
specific field changes don't require re-approval. In this case,
the status is first changed to DraftDraft  and is then automatically
updated to ApprovedApproved. The approved PO is registered as a
new version.

You send the new version of the PO to the vendor. The new version is registered in the vendor collaboration
interface, and the status is changed to In External ReviewIn External Review.

The vendor approves the new version of the PO. The status is changed to ConfirmedConfirmed, either automatically, or
when you receive the response from the vendor and then
confirm the PO.

Vendors don't have to confirm a PO by using the vendor collaboration interface. They can also send an email or

communicate their acceptance of a PO via other channels. You can then manually confirm the order. In this case,

you receive a warning that states that the order is being confirmed even though there is no response from the

vendor. The PO then appears in the confirmation history as an open confirmed order that doesn't have any

responses. At this point, the vendor no longer has the option to confirm or reject the PO.

The version of the PO that is available to other processes in Supply Chain Management is always the latest version, even

if that version hasn't yet been registered in the vendor collaboration interface.

If change management is enabled for POs, POs go through an approval workflow to reach the ApprovedApproved status.

This process isn't visible to the vendor.

The following table shows an example of the changes in status and version that a PO might go through when

change management is turned on. A version is registered when the PO is approved, not when the PO is sent to

the vendor or confirmed.



Sharing information about consignment inventory

Working with RFQs when you use vendor collaboration

Alternates, attachments, amendments, and returnsAlternates, attachments, amendments, and returns

Public sector extensions

If you're using consignment inventory, vendors can use the vendor collaboration interface to view information

on the following pages:

Purchase orders consuming consignment inventor yPurchase orders consuming consignment inventor y  – POs for consignment inventory are generated

when the ownership of the inventory is changed from the vendor to your company. A product receipt is

posted at the same time. These consignment POs are shown only on the Purchase orders consumingPurchase orders consuming

consignment inventor yconsignment inventor y  page. They aren't included on the All confirmed purchase ordersAll confirmed purchase orders  page in the

Vendor collaborationVendor collaboration module.

Products received from consignment inventor yProducts received from consignment inventor y  – This page lists all the transactions where the

ownership of products has been transferred from the vendor to your company. Vendors can use this

information to invoice the customer.

On-hand consignment inventor yOn-hand consignment inventor y  – This page shows the vendor-owned on-hand consignment inventory

that has been received at your warehouse.

This section describes the interactions between customers and vendors during the RFQ process. It also explains

how information is communicated to the vendors. For a basic overview of support for the RFQ process, see

Requests for quotation (RFQs) overview.

AlternatesAlternates  – On the header of an RFQ case, you can specify that alternates are allowed for non-catalog

item lines. When alternates are enabled, vendors can add an alternate line for each requested line.

AttachmentsAttachments  – Attachments can be added at both the header level and the line level of an RFQ case.

Attachments can be classified as either internal or external. Internal attachments can be viewed only on

the customer side, whereas vendors can view external attachments after they are sent.

Vendors can also add attachments on their bid reply. These attachments can be viewed on the customer

side after a vendor submits the bid reply. Attachments that vendors add are always classified as external.

To access an attachment that a vendor has submitted together with a bid, select Bid attachmentsBid attachments  or BidBid

line attachmentsline attachments .

To open attachments that were sent together with the RFQ case, use the document handling paper clip

symbol on the reply.

AmendmentsAmendments  – When an amendment is finalized, the existing bid replies are removed so that they can

be replaced by updated values. Information such as the line price and quantity from previous bid replies

can be viewed via the journals on the RFQ case.

To enforce amendment processing, on the Procurement and sourcing parametersProcurement and sourcing parameters  page, on the

Request for quotationsRequest for quotations  FastTab, set the Lock RFQs when they are sentLock RFQs when they are sent option to YesYes . (This option is

set and required for Public sector.)

ReturnsReturns  – If a vendor has submitted a bid, but more or modified information is required for the RFQ

case, the customer can return the bid to the vendor. The data from the bid that was previously submitted

is retained, and the vendor can make the requested modifications without having to restart the bid

process.

For Public sector, the extended functionality enables an RFQ case to be sent to vendors and published. When you

publish an RFQ, anyone who requests the information can view the work that complies with most public-sector

regulations. All available work is reflected on the Open published requests for quotationsOpen published requests for quotations  list page, and the
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canceled, pending, or awarded RFQs can be viewed on the Closed published requests for quotationsClosed published requests for quotations  list

page. These documents can also be viewed on a site outside Supply Chain Management through integrations

with the following data entities:

Published requests for quotations

Published requests for quotations line

Published requests for quotations header attachments

These entities let people who aren't provisioned users in Supply Chain Management, but who have anonymous

access to the external site, view the available and closed work. Additionally, extended functionality in Send andSend and

publishpublish lets the user who sets up parameters for the RFQ process define an email template. Then, when the

procurement professional creates the RFQ case, he or she must select the email template to send the required

information to the vendors on the RFQ case.

The user who sets up parameters for the RFQ process can create multiple email templates. These email

templates can contain both static text and the following replacement tokens. The tokens will be replaced with

contextual values when an email is created.

%RFQCase%

%RFQCaseName%

%bidType%

%inviteOnly%

%expiryDateTime%

%requester%

%requestingDepartment%

%accountnum%

%todaysdate%

%createddate%

If an amendment is required and is sent after the RFQ is sent, the RFQ will be resent to all invited vendors. The

published document will also be updated on the Open published requests for quotationsOpen published requests for quotations  page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

Working with POs in the Purchase order confirmation workspace

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

This topic describes how you can use vendor collaboration to work with customers in Microsoft Dynamics 365

Supply Chain Management. Vendors can complete a series of business processes from the following

workspaces:

Purchase order confirmationPurchase order confirmation – Monitor and respond to purchase orders (POs).

Vendor biddingVendor bidding – View requests for quotation (RFQs), and respond to them by entering bids.

Vendor informationVendor information – View and update vendor master data.

InvoicingInvoicing – Work with invoices. This topic doesn't cover the InvoicingInvoicing workspace. For more information

about this workspace, see Vendor collaboration invoicing workspace.

Vendors can also monitor information about consignment inventory.

The Purchase order confirmationPurchase order confirmation workspace lets you respond to the purchase orders (POs) that have been

sent to you for review. It also lets you view information about POs that are awaiting action from the customer,

and POs that have been confirmed but are still open.

There are three lists in the Purchase order confirmationPurchase order confirmation workspace:

Purchase orders for reviewPurchase orders for review  – This list shows POs that have been sent to you and are awaiting a response

from you. After you respond, the PO disappears from the list. If the customer sends you a new version of the

PO before you've responded to the previous version, only the latest version is shown.

Awaiting customer actionAwaiting customer action – This list shows all the POs that you've responded to but that the customer

hasn't yet confirmed. If you accept a PO, you can monitor it in this list until the status is changed to

ConfirmedConfirmed. If you reject a PO or accept it with changes, you can monitor it here until the customer sends a

new version.

Open confirmed purchase ordersOpen confirmed purchase orders  – This list shows all the POs for your account that have a status of

ConfirmedConfirmed. When products or services are fully received against the PO, the PO disappears from the list.

You can use the following pages to work with POs:

Purchase orders for reviewPurchase orders for review  – This page contains the same information as the Purchase orders forPurchase orders for

reviewreview  list in the workspace. See the description earlier in this topic.

Purchase order vendor confirmation histor yPurchase order vendor confirmation histor y  – This page contains all POs and all versions of POs that

have been sent to the vendor. It also contains all the responses that have been returned from the vendor.

Open confirmed purchase ordersOpen confirmed purchase orders  This page contains the same information as the Open confirmedOpen confirmed

purchase orderpurchase order  list in the workspace. See the description earlier in this topic.

All confirmed purchase ordersAll confirmed purchase orders  – This page contains all the POs that have been confirmed. The POs that

are shown on this page include POs where products or services have been received. You can use this list to

monitor POs that you can send invoices for.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/vendor-collaboration-work-customers-dynamics-365-operations.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version
file:///T:/eiye/ac1a/dynamics365/financials/accounts-payable/vendor-portal-invoicing-workspace.html


Responding to POsResponding to POs

Monitoring consignment inventory

Working with RFQs in the Vendor bidding workspace

Viewing RFQsViewing RFQs

The POs that the customer sends you to review appear in the Purchase order confirmationPurchase order confirmation workspace and

on the Purchase orders for reviewPurchase orders for review  page. After you open a PO, you can accept it, reject it, or accept it with

changes. There might be attachments on the PO header or on individual lines. Additionally, you can attach

information to your response on the PO header or individual lines. For example, you might suggest a substitute

item for one of the lines.

You can preview and print the PO as a PDF file by using the Preview/PrintPreview/Print option. You can also use the DisplayDisplay

dimensionsdimensions  action to hide or show the following dimension columns: S iteSite, WarehouseWarehouse, ColorColor , S izeSize, StyleStyle,

and ConfigurationConfiguration.

If you use the Accept with changesAccept with changes  option, you can accept or reject individual lines. You can also make the

following changes to lines:

Change dates or quantities. To update the confirmed delivery date on all lines, use the Update deliver yUpdate deliver y

datedate option on the PO header.

Split lines for different delivery dates or quantities.

Substitute an item. In the L ine detailsL ine details  section, enter an item description and the item number in the

ExternalExternal  field.

You can't change pricing information or charges, but you can use notes to make suggestions for these changes.

If the customer sends you a new version of a PO, it will have a version suffix to indicate that it's a modified

version of a PO that was previously sent. The Purchase order vendor confirmation histor yPurchase order vendor confirmation histor y  page lets you

track the history of each order.

If you're using consignment inventory, you can use the vendor collaboration interface to view information on

the following pages:

Purchase orders consuming consignment inventor yPurchase orders consuming consignment inventor y  – POs for consignment inventory are generated

when the customer takes ownership of the inventory. These consignment POs are shown only on this page.

They aren't included on the All confirmed purchase ordersAll confirmed purchase orders  page.

Products received from consignment inventor yProducts received from consignment inventor y  – This page lists all the transactions where the

ownership of products has been transferred to the company that is consuming the inventory. You can use

this information to invoice the customer.

On-hand consignment inventor yOn-hand consignment inventor y  – This page shows the on-hand consignment inventory that is owned

by your company, but that is on hand at the customer's warehouse.

The Vendor biddingVendor bidding workspace lets you view the requests for quotation (RFQs) that your company has been

invited to respond to. You can also respond to the RFQs.

The workspace also shows all the RFQs that you've lost or won. Additionally, if the system is configured for the

public sector, the workspace shows the RFQs that are publicly available.

Open the Vendor biddingVendor bidding workspace to access the following information:

Select New bid invitationsNew bid invitations  to see the RFQs that your company has been invited to respond to. From here,

you can view an RFQ and start the bidding process. You can also see amended RFQs that a new bid must be

submitted for.

Select Returned bidsReturned bids  to see the RFQs that the customer has returned to you so that you can provide more



Working with RFQs that are publicly availableWorking with RFQs that are publicly available
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BiddingBidding

information or update the bid.

Select Bids in progressBids in progress  to see the RFQs that you or a contact person who represents your company has

been working on but hasn't yet submitted.

Select Awarded bidsAwarded bids  to see when the customer has awarded at least one line item in your bid.

Select Lost bidsLost bids  to see bids where all lines have been rejected.

Select the Request for quotationsRequest for quotations  link to see a list of all the vendor's RFQ invitations and any bids that

have been submitted. The Request for quotationsRequest for quotations  page lists all the RFQs that a vendor has been involved

in. You can search by status.

Select the Declined bidsDeclined bids  link to see a list of all the RFQs where a vendor's contact person has declined to

bid.

People who work in the Public sector can see open and expired RFQs that have been made available to the

public.

Select the Open published requests for quotationsOpen published requests for quotations  link to see a list of open RFQs that are available

to the public. An open RFQ is an RFQ that hasn't yet expired. You can find the expiration date and time on

the header of the RFQ.

If you've been invited to bid, you can find the same RFQ on the New bid invitationsNew bid invitations  page. Sometimes,

you might want to bid on an open RFQ, but you haven't been invited to bid. In this case, you might be

able to invite yourself, provided that the customer has enabled self-invitation for the RFQ case.

Enhance the accessibility of the Open published requests for quotationsOpen published requests for quotations  link by turning on the

Display the "Open published requests for quotation" link as a tileDisplay the "Open published requests for quotation" link as a tile feature. This feature converts

the link to a tile and moves it to a prominent location, so that it's easy to find.

Select the Closed published requests for quotationsClosed published requests for quotations  link to see a list of closed RFQs that are

available to the public. A closed RFQ is an RFQ that has expired. You can find the expiration date and time

on the header of the RFQ.

A closed RFQ shows all vendor bids down to the line level. As bids are awarded or rejected, this

information is reflected in the closed RFQ. Any attachments that are included in the bid are also available.

This functionality is available only if the Public sector configuration is turned on.

Select BidBid to start to bid on an RFQ.

When the editing is enabled for bid fields on the headers and lines of an RFQ, you can enter your bid

directly in the line grid. You must also consider any additional bid information that should be added in the

line details.

When you start to work on a bid, it appears in the Bids in progressBids in progress  section.

At any time before the expiration date, you can save a bid. You can then return later to finish and submit

the bid. After you submit a bid, you can recall and update it up until the expiration date.

Select Reset from RFQReset from RFQ to reset the data that you entered for a bid and revert to the original RFQ. You

can reset the header or the line.

Select Add alternateAdd alternate or Remove alternateRemove alternate in the line grid to work with alternates.

Some RFQs allow for alternate bids. You can specify alternate bids only for lines of the Categor yCategor y  type,



Accessing vendor master data in the Vendor information workspace

Additional resources
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because specific items can't be added as alternates.

Select RFQ attachmentRFQ attachment or RFQ lines attachmentRFQ lines attachment to open any attachment that the customer has

added to an RFQ. Select Bid attachmentsBid attachments  or Bid line attachmentsBid line attachments  to upload attachments together

with the bid.

There might be questionnaires that you must answer before you're allowed to submit a bid.

Select DeclineDecline if you don't want to bid. After you select DeclineDecline, you can't recall the action and enter a

bid.

If an RFQ is amended, you must enter a new bid. You can find information about the amendment on the

AmendmentsAmendments  tab of the RFQ page. Amended RFQs appear on the New bid invitationsNew bid invitations  page.

As a vendor, you can access part of the information that the customer maintains in the vendor master record.

Therefore, you can keep the information up to date. To update the information, you must have a vendor admin

(external) role.

The accessible information is the vendor name, addresses, contact information, contact persons and their

contact information, identification numbers, tax registration numbers, procurement categories that the vendor is

approved to sell to the customer in, and information about certifications.

Manage vendor collaboration users

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Vendor catalogs import

Import vendor catalog data

Generate a catalog import file template

In Dynamics 365 Supply Chain Management, purchasing professionals can create and maintain catalogs for

company employees to use when they order items and services for internal use. To create a procurement

catalog, you can add the items and services that you want to make available to employees, either by importing

the product catalog data or by manually adding the product catalog data to the product master.

You can upload catalog data submitted by a vendor from the Microsoft Dynamics 365 client.

The product data that a vendor submits to you, in the form of a catalog maintenance request (CMR) file, must be

in XML file format. The CMR file should contain the details for the products that the vendor supplies to your

company.

To import vendor catalog data, you must complete the following tasks:

1. Set up a project in the Data management workspace where you have defined your data mapping rules.

Select Data managementData management and then select Set up roles for data projectsSet up roles for data projects .

2. Set up a procurement category hierarchy, and assign your vendors to procurement categories. If you use

commodity codes, add the commodity codes to the procurement categories. For information about

setting up a procurement category hierarchy, see Set up a procurement category hierarchy.

3. Configure the vendor for catalog import. Select a vendor, and then select ProcurementProcurement > Set upSet up >

Configure vendor for catalog impor tConfigure vendor for catalog impor t.

4. Configure workflow for catalog import. Create a CMR file template and share this with your vendor.

5. Select Procurement and sourcingProcurement and sourcing > CommonCommon > CatalogsCatalogs  > Vendor catalogsVendor catalogs  to create a vendor

catalog. The catalog maintenance request (CMR) files that you receive from your vendor are grouped in

this catalog.

6. Upload the CMR file.

7. Review, approve, or reject the products in the vendor catalog. The products are automatically mapped to

the procurement categories.

Approved products are added to the product master and are released to the selected legal entities. Only

approved products can be added to the procurement catalog.

The catalog import file template is an XSD file that you use to create a CMR file for a vendor's products. You can

use the CMR file to create a new catalog, replace an existing catalog, or modify an existing catalog.

1. Select Procurement and sourcingProcurement and sourcing > CatalogsCatalogs  > Vendor catalogsVendor catalogs  and double-click the catalog that

you want to work with.

2. Download a current catalog import template (XSD file). On the Update catalogUpdate catalog page, on the ActionAction

PanePane, on the CatalogsCatalogs  tab, in the Related informationRelated information group, click Generate catalog templateGenerate catalog template and

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/vendor-catalogs-import.md
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select Procurement categor yProcurement categor y .

With the Procurement categor yProcurement categor y  option you can generate a catalog template that includes the

procurement categories in which the vendor is authorized to provide products.

3. In the Save asSave as  dialog box, select the location where you want to store the catalog file template and save

the file.

For more information and for examples, refer to this blog post: Vendor catalogs in Dynamics AX.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://blogs.msdn.microsoft.com/dynamicsaxscm/2016/05/25/vendor-catalogs-in-dynamics-ax/
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


 

Set up an external catalog for PunchOut e-
procurement
2/18/2021 • 7 minutes to read • Edit Online

Setting up an external catalog

To set up an external vendor catalog, complete the following tasks:To set up an external vendor catalog, complete the following tasks:

Configure the external vendor catalog

By using the external catalog, you can ensure that the product and price information that you subsequently

process in Supply Chain Management is accurate and up to date. The requisition can then be approved and

converted to a purchase order and an order can be placed at the vendor.

When the external catalog is set up and an employee is preparing a requisition, there will be an option to

redirect to an external site, the external catalog, and return the shopping basket that was created at the external

site. This communication is based on the cXML protocol and it has to be set up between the systems of the

buying and the selling organization.

To set up the communication, your vendor has to provide pieces of information for you to use in the

configuration of the external catalog such as Identity, domain of the buyers company, for example, "DUNS" and

"DUNS number", credentials, and the URL to reach the vendors catalog.

The external catalog should enable an employee who enters a purchase requisition to be redirected to an

external site to select products. The products that the employee selects from the external catalog are returned

with up-to-date price information and from here, they can be added to the purchase requisition. The intention is

not to enable employees to place an order on the external site. When setting up the external catalog, you need to

make sure that the purpose of the site that can be accessed by the external catalog is to collect quote

information and not to place a real order.

1. Set up a procurement category hierarchy. For more information, see Set up policies for procurement

category hierarchies.

2. Register the vendor in Supply Chain Management. Before you can set up configurations to access an external

vendor's catalog, you must set up the vendor and the vendor contact in Microsoft Dynamics 365. The

external catalog's vendor must also be added to the selected procurement category. For more information

about registering vendors, see Manage vendor collaboration users. For information about how to assign

vendors to a procurement category, see Approve vendors for specific procurement categories.

3. Make sure that the units of measure and the currency that the vendor uses are set up. For information about

how to create a unit of measure, see Manage unit of measure.

4. Configure the external vendor catalog by using the requirements for your vendor's external catalog site. For

more details about this task, see Configure the external vendor catalog.

5. Test the vendor's external catalog configurations to verify that the settings are valid and that you can access

the vendor's external catalog. Use the Validate settingsValidate settings  action to validate the request setup message that

you've defined. This message should cause the vendors external catalog site to be opened in a browser

window. During validation, you can't order items and services from the vendor. To order items and services,

you must access the vendor's catalog from a purchase requisition.

6. Activate the external catalog by using the Activate catalogActivate catalog button on the External catalogsExternal catalogs  page. The

external catalog must be activated before employees can use it. You can inactivate the external catalog at any

time.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/set-up-external-catalog-for-punchout.md


cXML setup messagecXML setup message

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

< Header >< From >< Credential domain=”” > The domain of the buyer's company.

< Header >< From >< Credential>< Identity >< /Identity
>

The identity of the buyer's company.

< Header >< To >< Credential domain=”” > The domain of the vendor's company.

< Header >< To >< Credential>< Identity >< /Identity> The identity of the vendor's company.

This section gives more details about task 4 in the preceding section.

NOTENOTE

1. Enter a name and description for the vendor's external catalog. The name that you enter will appear on

the cart that represents the external catalog that is shown to employees who creates a requisition.

Employees can click on the cart to open the catalog on the vendor's external catalog site.

2. Add an image by using the External catalog imageExternal catalog image action. The image will appear on the cart that

represents the external catalog that is shown to employees who create a requisition. Note that the

image's width and height must be equal. Otherwise the image won't be displayed correctly.

3. Select whether the vendor's external catalog website should appear in the same browser window as the

one where the employee has created the requisition, or if it should open in a new window.

4. Select the vendor for the catalog. In the Legal entitiesLegal entities  list, there is a row for each legal entity where the

vendor is set up. To allow users to request products directly from the vendor's catalog in some legal

entities but not others, you can use the Prevent accessPrevent access  or Allow accessAllow access  button for each legal

entity where you want the catalog to be or not to be available.

5. In the Default expiration (Days)Default expiration (Days)  field, enter the number of days that a quotation received from the

external catalog is valid and can be used to purchase from the external vendor. When a quotation is

created and retrieved from the vendor's external catalog site, the quotation is valid as of the current

system date and remains valid for the number of days that you enter in this field.

6. Click the AddAdd button to start mapping the procurement categories to the external catalog. Then, in the

Category name list, select a category. The list of categories is a superset of procurement categories that

the vendor has been mapped to in all the legal entities that are set up for the vendor.

Procurement policies are used to allow or restrict access to categories for the buying legal entity or receiving

operating unit. Punchout to an external catalog requires that access be allowed to at least one of the procurement

categories that is mapped to the catalog.

7. Set up the cXML setup request message that will be sent to the vendor. The automatically generated

message format is the minimal template that is required in order to start a session. Fill in values for the

tags.

At any time, you can reload the system-generated message template by clicking Restore message formatRestore message format. 

Note that if you restore the message format, the current message will be replaced by the automatically

generated message format, which has empty tags.

Below you can find a description of the tags that are included in the template:



< Header >< Sender >< Credential domain=”” > The domain of the buyer's company.

< Header >< Sender >< Credential >< Identity ><
/Identity>

The identity of the buyer's company.

< Header >< Sender >< Credential >< SharedSecret ><
/SharedSecret >

The shared secret for the buyer's company.

< Request deploymentMode=”” > The test or production deployment.

< Request >< PunchOutSetupRequest >< SupplierSetup ><
URL >< /URL>

The URL of the vendor's PunchOut endpoint.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Extrinsic elementsExtrinsic elements

Post back message

M ESSA GE REC EIVED F RO M  VEN DO RM ESSA GE REC E IVED F RO M  VEN DO R C O P IED TO  REQ UISIT IO N  L IN EC O P IED TO  REQ UISIT IO N  L IN E

< ItemIn quantity=”” > Quantity

< ItemIn>< ItemID >< SupplierPartID >< /SupplierPartID > External item ID

< ItemDetail>< UnitPrice >< Money currency=”” > Currency

< ItemDetail >< UnitPrice >< Money >< /Money > Unit price

< ItemDetail >< Description ShortName=”” > Product name

< ItemDetail >< Description >< /Description > Included in item description; Product name if ShortName is
not specified.

< ItemDetail >< UnitOfMeasure >< /UnitOfMeasure > Unit

< ItemDetail >< Classification >< /Classification > Included in item description

< ItemDetail >< Classification domain=”” > Included in item description

An extrinsic element is additional information, such as a user name that is based on a user that punches out. The

extrinsic element is set when the PunchOut occurs and it can be sent in the request setup message. Your vendor

could have a requirement for receiving an extrinsic element in the setup request. In that case, you should add

the extrinsic element to the list of extrinsic elements in the Message formatMessage format section of the External catalogExternal catalog

page. Specify a name for the extrinsic element that the vendor can recognize and map it to a value. The options

for values are: User name, User email, or Random value. For more information about the cXML protocol, see the

cXML.org website.

The post back message is the message that is received from the vendor when the user checks out from the

external site and returns to Supply Chain Management. Post back messages can't be configured. The messages

are based on the cXML protocol definition. Here is the information that can be part of the post back message

that is received on a requisition line.

http://cxml.org/
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Delete an external catalog with the Delete action on the page.

If a product from the external vendor catalog has been requested, the external vendor catalog cannot be deleted.

Instead, the status of the external vendor catalog is set to inactive. If you want to remove access to the external

vendor's catalog site, but not delete it, change the external catalog status to Inactive.

Purchasing cXML enhancements

Use external catalogs for PunchOut e-procurement

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Turn on the Purchasing cXML Enhancements feature

Set up global cXML parameters

The Purchasing cXML Enhancements feature builds on the existing external catalog functionality that is used for

purchase requisitions. This existing functionality is known as PunchOut. Although a purchase order doesn't have

to originate from a purchase requisition, there must be a connection between the vendor on a purchase order

and the parameters that are used to send the purchase order document.

To turn on the feature, open the Feature managementFeature management page, and search for the feature that is named

Purchasing cXML Enhancements. Select the feature, and then select Enable nowEnable now  to turn it on.

After you turn on the feature, you should configure settings in the following three areas:

cXML parameterscXML parameters  – Use these settings to set up some global parameters for the functionality for sending

purchase orders.

Vendor setupVendor setup – If commerce eXtensible Markup Language (cXML) should be used by default for all new

purchase orders that are created for any vendor, set the Send purchase order via cXMLSend purchase order via cXML  option to Yes for

that vendor.

External catalogsExternal catalogs  – Use the new Order proper tiesOrder proper ties  settings to define the format of the purchase order

document and how it's sent.

The following illustration summarizes this configuration.

In addition, you must set up the Purchase order request batch job. This batch job is used to send the confirmed

purchase orders.

Use the cXML parameterscXML parameters  page to make a few global settings that apply to the functionality for sending

purchase orders.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/purchasing-cxml-enhancements.md
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Go to Procurement and sourcing > Setup > cXML management > cXML parametersProcurement and sourcing > Setup > cXML management > cXML parameters , and set the

following parameters:

cXML test modecXML test mode – This global parameter affects the way that purchase orders are physically sent from

the batch job. Select one of the following values:

TestTest – In this mode, the batch job can be running, and the XML document for the message is

generated, but it isn't sent. Instead, it's saved on the purchase order request for review purposes. This

mode is helpful when you're in an initial implementation, and you want to see how data is entered in

the cXML message. You might also want to generate sample messages that you can send to vendors

for initial validation.

L iveLive – In this mode, the feature uses the external catalog settings to physically transmit each

document to the vendor.

Send purchase request updatesSend purchase request updates  – Set this option to Yes to send an update message for purchase

orders. Set it to No to prevent the message from being sent. Most vendors prefer not to receive update

messages. Instead, they require that customers contact them by phone or email if a purchase order

should be changed. This parameter is a global parameter, and no override can be specified on the external

catalog for each vendor. A purchase order will be marked as updated if you post a second confirmation

on a purchase order, but the first confirmation has already been sent and acknowledged by the vendor. If

there is a second confirmation, but the first confirmation hasn't been sent, the second confirmation will

be treated as a new document. You can confirm a purchase order as many times as you want until one

confirmation is sent. The next confirmation will then be treated as an update message.

Send purchase request deleteSend purchase request delete – Set this option to Yes to send a delete message for purchase orders.

Set it to No to prevent the message from being sent. Most vendors prefer not to receive delete messages.

Instead, they require that customers contact them by phone or email if a purchase order was sent by

mistake. This parameter is a global parameter, and no override can be specified on the external catalog

for each vendor. A purchase order will be marked as deleted if you cancel the purchase order in Supply

Chain Management.

Archive fileArchive file – Specify the file path where you want to export and save archived cXML documents. The

path is used when you run the purge function from the Purchase order requestPurchase order request page.

Max characters for street lineMax characters for street line – Enter the maximum number of characters that can be used in the

street field for addresses in the cXML document. This global parameter affects all vendors unless an

override is specified on the external catalog properties.

Every time that you confirm a purchase order where the Send purchase order via cXMLSend purchase order via cXML  option is set to Yes,

the system automatically generates the cXML message and delivers it to the vendor that is associated with that

purchase order. There are two ways to control this option for your purchase orders:

To set up a vendor so that it automatically uses cXML for all new purchase orders that are created from a

requisition, go to Procurement and sourcing > Vendors > All vendorsProcurement and sourcing > Vendors > All vendors , and select or create a vendor to



  Set up an external catalog to use cXML

NOTENOTE

Set the PunchOut protocol typeSet the PunchOut protocol type

open its details page. Then, on the Purchase order defaultsPurchase order defaults  FastTab, set the Send purchase order viaSend purchase order via

cXMLcXML  option to Yes. If cXML should also automatically be used for new purchase orders that are notnot created

from a requisition, you must also set the ENABLEMANUALPOENABLEMANUALPO order property to True for the related

external catalog, as described in the Set the order properties section later in this topic.

For individual purchase orders, go to Procurement and sourcing > Purchase orders > All purchaseProcurement and sourcing > Purchase orders > All purchase

ordersorders , and select or create a purchase order to open its details page. Switch to the HeaderHeader  view, and then,

on the SetupSetup FastTab, set the Send purchase order via cXMLSend purchase order via cXML  option as required.

On the External catalogsExternal catalogs  page, for each of your catalogs, you can set up the PunchOut functionality and the

functionality for sending purchase orders. To find the relevant settings, go to Procurement and sourcing >Procurement and sourcing >

Catalogs > External catalogsCatalogs > External catalogs . Start by setting up each catalog as usual. This process includes assigning a

vendor, selecting the categories that the vendor is allowed to supply, and activating the catalog. Then configure

the additional settings that are described in this section.

When you confirm a purchase order that can be sent via cXML, the system looks up the vendor that is associated with

the purchase order and then finds the first active external catalog that is associated with that vendor. The system then

uses the settings from that external catalog to send the purchase order. If multiple external catalogs are set up, the

system uses only the first external catalog that it finds, based on the vendor on the purchase order. Therefore, we

recommend that you create just one external catalog for each vendor.

On the GeneralGeneral  FastTab of the External catalogsExternal catalogs  page, set the Punchout protocol typePunchout protocol type field to cXML. This

option will be the only available option, unless a partner has extended the functionality and provides an

additional option in the extension.



    Set the order propertiesSet the order properties

If you're also using the catalog for PunchOut, you must also set up the message format. The message format is

used to establish the connection to the vendor in the PunchOut transaction from the requisition. When a

purchase order is sent, the order properties will be used to establish the connection with a vendor.

The Purchasing cXML Enhancements feature adds a new Order proper tiesOrder proper ties  FastTab for external catalogs. This

FastTab provides a grid where you can define the order properties. It also provides a toolbar. This toolbar

contains the following three buttons that you can use to manage the order properties:

Default proper tiesDefault proper ties  – When you're setting up a new catalog, select this button to add a predefined collection

of commonly used properties to the grid.

NewNew  – Add a new property to the grid.

DeleteDelete – Delete the currently selected property from the grid. If you accidentally delete a default property,

select Default proper tiesDefault proper ties  to restore all the missing properties.

Every time that you add one or more properties to the grid, use the right column to specify a value for each.

Use the default properties in the following way:

BUYER_COOKIEBUYER_COOKIE – This tracking field can be used to indicate specific information for your company.

Unless you have an agreement with the vendor about how this property is used, it doesn't have very

much meaning when sending a purchase order. Therefore, you should set it to a simple value.

DELIVERTODELIVERTO – When the shipping address is entered in the document from the purchase order, the

Attention informationAttention information field is used to set the DeliverToDeliverTo field in the XML message. If you require that

this value be a requester name, and you will set the requester field on the purchase order header, enter

the value REQUESTER for this property, so that the requester name will be entered in the DeliverToDeliverTo field

in the XML. In this case, the primary email address and phone number that are used will be from the

requester instead of the orderer.

DEPLOYMENTMODEDEPLOYMENTMODE – Set this property as required by the vendor. The values are usually

PRODUCTION or TEST. Set the value based on your communication with the vendor. Usually, it must

match the intended system behind the ORDERCHECKURLORDERCHECKURL  value that the vendor indicates as a test or

production system.

FIXEDBILL ADDRESSIDFIXEDBILL ADDRESSID – When the addressIDaddressID field in the XML message is set, it picks up the location

that is specified on the address. If the ID value that you've communicated to the vendor differs from the

value on the address location for some reason, you can force an override by specifying the value here.

The assumption is that you will use only one address with the vendor, and that the address is set up in the

vendor's system. The billing address is the primary invoice address that is specified for the legal entity in

Supply Chain Management.

FIXEDSHIPADDRESSIDFIXEDSHIPADDRESSID – When the addressIDaddressID field in the XML message is set, it picks up the location

that is specified on the address. If the ID value that you've communicated to the vendor differs from the

value on the address location for some reason, you can force an override by specifying the value here.

The assumption is that you will use only one address with the vendor, and that the address is set up in the

vendor's system. The shipping address is the address that is specified on the header of the purchase

order. Most vendors accept only header addresses, not line addresses. Although there are fields for line

addresses in the XML, they will be set to the header address.

FROM_DOMAINFROM_DOMAIN – Enter the value that is used to send purchase order documents. This value is supplied

by your vendor.

FROM_IDENTITYFROM_IDENTITY – Enter the value that is used to send purchase order documents. This value is

supplied by your vendor.

ORDERCHECKURLORDERCHECKURL  – Enter the URL to transmit the purchase order documents to. This URL starts with 



https://  and is supplied by your vendor.

PAYLOAD_IDPAYLOAD_ID – Enter a prefix value for the payload ID, as required for the business processes that are in

place for the current vendor.

SENDER_DOMAINSENDER_DOMAIN – Enter the value that is used to send purchase order documents. This value is

supplied by your vendor.

SENDER_IDENTITYSENDER_IDENTITY – Enter the value that is used to send purchase order documents. This value is

supplied by your vendor.

SHARED_SECRETSHARED_SECRET – Enter the value that is used to send purchase order documents. This value is

supplied by your vendor.

STREETLENGTHSTREETLENGTH – Enter a number that represents the maximum number of characters that the vendor

will accept as a street name. If a value is entered here, it overrides the value that is specified on the cXMLcXML

parametersparameters  page. The system will remove line breaks and spaces to try to fit the standard address in

Supply Chain Management into the number of characters that is specified here. Any additional characters

will be truncated.

TO_DOMAINTO_DOMAIN – Enter the value that is used to send purchase order documents. This value is supplied by

your vendor.

TO_IDENTITYTO_IDENTITY – Enter the value that is used to send purchase order documents. This value is supplied by

your vendor.

USERAGENTUSERAGENT – Enter a value to identify the system that you're using. For example, enter Dynamics 365

Supply Chain Management.

VERSIONVERSION – Enter a cXML version number, if the vendor requests this information. The default version is

1.2.008. This version is stable and is accepted by most vendors.

RESPONSETEXTRESPONSETEXT – Enter any custom text that you expect the vendor to return in the cXML response

message after the order has been sent. In this way, the system can mark the message as Acknowledged. If

the response doesn't match standard text or the customer text that you enter here, the request will be

marked as Error.

RESPONSETEXTSUBRESPONSETEXTSUB – Set this property to TRUE if you want to search the vendor response text for the

values that are specified in the RESPONSETEXTRESPONSETEXT field. For example, the vendor might return a long string

that includes "OK" in the response. In this case, you can enter OK in the RESPONSETEXTRESPONSETEXT field and set

RESPONSETESTSUBRESPONSETESTSUB to TRUE to search for "OK" anywhere in the response. The order can then be set to

Acknowledged.

CONTENTTYPECONTENTTYPE – In a typical catalog setup, you don't have to set this property. If you receive a server

500 error from a vendor's system when you send a purchase order, you can do testing by setting this

property to FALSE. That value will change a setting in the web request and might enable the message to

be sent for some platforms.

ENABLEHEADERSENABLEHEADERS  – Set this property to TRUE to send headers together with the purchase order. You

must set this property only if the vendor requires it. If you set this property to TRUE, add extra custom

properties that are based on the names that the vendor provides, and prefix them with H_. Typical

examples include H_USERIDH_USERID, H_PASSWORDH_PASSWORD, H_RECEIVERIDH_RECEIVERID, and H_ACTIONREQUESTH_ACTIONREQUEST. The

following custom properties are included in the default properties:

H_USERIDH_USERID – If the trading partner requires that you send a user ID as part of the URL to submit a

purchase order, enter the value here.

H_PASSWORDH_PASSWORD – If the trading partner requires that you send a password as part of the URL to

submit a purchase order, enter the value here.



ENABLEMANUALPOENABLEMANUALPO – If this property is set to TRUE, when users manually create purchase orders (that

is, when they don't start from a requisition), those purchase orders will inherit the setting of the SendSend

purchase order via cXMLpurchase order via cXML  option from the vendor. If this property isn't set, or if it's set to FALSE, the

Send purchase order via cXMLSend purchase order via cXML  option won't be set on the purchase order header for manually

created purchase orders. For purchase orders that are created from a requisition, the setting of the SendSend

purchase order via cXMLpurchase order via cXML  option is always inherited from the vendor, regardless of the setting of this

property. For more information, see the Set up vendor purchase orders to use cXML section earlier in this

topic.

PUNCHOUTPOONLYPUNCHOUTPOONLY – If this property is set to TRUE, only purchase requisition lines that are created

from the PunchOut process will set the Send purchase order via cXMLSend purchase order via cXML  option on the purchase order

header. In addition, the purchase requisition line type of all lines on the purchase order must be External

catalog item. Otherwise, the cXML purchase order can't be created.

PUNCHOUTSHIPTOPUNCHOUTSHIPTO – If this property is set to TRUE, the default address of the legal entity will be added

to the PunchOut setup request message when the user opens an external catalog. This address is added

as the ShipToShipTo address. Vendors will use the ShipToShipTo address to show pricing based on the company

location.

TRACEPUNCHOUTTRACEPUNCHOUT – Set this property to TRUE if you receive an error message when you try to browse

to an external catalog from the requisition. Trace information will then be filled in for the

PunchOutSetupRequestPunchOutSetupRequest and PunchOutResponsePunchOutResponse messages that are sent between Supply Chain

Management and the vendor site. You can view this information on the cXML car t message logcXML car t message log page,

which you can open from the External catalog setupExternal catalog setup page for the vendor catalog that you're have

having issues with. You should set this property to TRUE only if you're troubleshooting, because it creates

a large performance overhead on the database for each PunchOut. For more information, see the View

the cXML cart message log for external catalog PunchOut section later in this topic.

REPL ACENEWLINEREPL ACENEWLINE – Set this property to TRUE if you're having an issue because a vendor's system is

sending a PunchOutResponsePunchOutResponse message that includes newline characters (\n). This issue might occur if

the vendor's messages are parsed through middleware or a procurement hub. If you're having an issue

with a new vendor setup, set the TRACEPUNCHOUTTRACEPUNCHOUT property to TRUE to view the

PunchOutResponsePunchOutResponse message and determine whether the XML tags are broken up by newline

characters.

POCOMMENTSPOCOMMENTS  – Set this property to TRUE if you want the cXML document to include notes that are

attached to the purchase order in Supply Chain Management. The attachment text is included in the

header comments in the purchase order message. For more information about how the system selects

and processes these attachments, see the Attach notes to a purchase order section later in this topic.

VENDCOMMENTSVENDCOMMENTS  – Set this property to TRUE if you want the cXML document to include notes that are

attached to the purchase order in Supply Chain Management. The attachment text is included in the

header comments in the purchase order message. For more information about how the system selects

and processes these attachments, see the Attach notes to a purchase order section.

CLEANAMPCLEANAMP – Set this property to TRUE if you receive an error message when you try to do a PunchOut

to a vendor, and the vendor's return URL includes incorrectly encoded ampersands (&).

PUNCHOUTTZPUNCHOUTTZ – Set this property to TRUE if the vendor that you're working with uses the International

Organization for Standardization (ISO) 8601 standard to do a specific validation of the date/time of

PunchOut request message. Supply Chain Management uses the Coordinated Universal Time (UTC) date

in the PunchOutSetupRequestPunchOutSetupRequest message. Therefore, when you set this property to TRUE, +00:00 is

added to the date/time format.

WMSADDRESSIDWMSADDRESSID – Set this property to TRUE to use the warehouse number on the purchase order

header as the addressIDaddressID value in the ShipToShipTo address for the purchase order request that is sent to the



    

Activate the external catalogActivate the external catalog

Attach notes to a purchase orderAttach notes to a purchase order

vendor. If you set a value for the FIXEDSHIPADDRESSIDFIXEDSHIPADDRESSID property, that value takes precedence over this

value. Therefore, you should use one property or the other to set the addressIDaddressID value in the ShipToShipTo

address for the document.

PUNCHOUTSHIPTOUSERPUNCHOUTSHIPTOUSER  – This property works together with the PUNCHOUTSHIPTOPUNCHOUTSHIPTO property. If

PUNCHOUTSHIPTOPUNCHOUTSHIPTO is set to TRUE, the address for the legal entity is picked up. If

PUNCHOUTSHIPTOUSERPUNCHOUTSHIPTOUSER  is set to TRUE, the primary address from the PunchOut user is used instead

of the legal entity address.

When you've finished setting up all the properties and configuring other settings for your external catalog, go

back to the GeneralGeneral  FastTab of the External catalogsExternal catalogs  page, and set the ActiveActive option to Yes.

As was mentioned in the Set the order properties section, if you want your delivered cXML to include text from

notes that are attached to the relevant purchase order and/or vendor records, you can set the POCOMMENTSPOCOMMENTS

and/or VENDCOMMENTSVENDCOMMENTS  property to TRUE in the external catalog setup. This section provides more detail

about how the system selects and processes these attachments, if you use them.

To set the types of notes that the system will look for, go to Procurement and sourcing > Setup > Forms >Procurement and sourcing > Setup > Forms >

From setupFrom setup. Then, on the Purchase orderPurchase order  tab, set the Include documents of typeInclude documents of type field to the type of note

that you want to be able to include. Only text notes will be included, not document attachments.

Attachments will be included with a purchase order only if their TypeType field is set to the value that you select in

the Include documents of typeInclude documents of type field, and if their Restr ictionRestr iction field is set to External. To create, view, or edit the

attachments for a purchase order, go to Procurement and sourcing > All purchase ordersProcurement and sourcing > All purchase orders , select or create

a purchase order, and then select the AttachmentsAttachments  button (paperclip symbol) in the upper-right corner.



 View the cXML cart message log for external catalog PunchOut

Set the extrinsic elements for external catalog PunchOut

When you set the Punchout protocol typePunchout protocol type field to cXML for an external catalog, the system will capture a

message log of the carts that come back from vendors. This log can be used for troubleshooting and other data

purposes.

To open the log for an external catalog, select the relevant catalog, and then, on the Action Pane, select cXMLcXML

car t message logcar t message log. The cXML car t message logcXML car t message log page shows a list of the carts that have been returned, the

XML that is related to those carts, and the lines that were created on the related purchase requisition.

When you set the Punchout protocol typePunchout protocol type field to cXML for an external catalog, you can add custom extrinsic

elements that will be inserted at the correct place in the request XML message.

To add extrinsic elements to an external catalog, follow these steps.

1. Go to Procurement and sourcing > Catalogs > External catalogsProcurement and sourcing > Catalogs > External catalogs .

2. Select the relevant catalog.

3. On the Message formatMessage format FastTab, in the Extr insicsExtr insics  section, select AddAdd to add a row to the grid for each

extrinsic element that you want to include. On each row, set the following fields:

NameName – Enter a name for the element. This value will become the value of the namename attribute for

the Extr insicExtr insic XML element that is created by each row. Usually, you will work with your vendor to

agree on the name for each extrinsic element.

ValueValue – Select a value for the element. This value will become the value of the XML element that is

created by each row. The following values are available:
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User nameUser name – Use the name of the user who is doing the PunchOut. This name is the sign-in

name for Supply Chain Management.

User emailUser email  – Use the email address of the user who is doing the PunchOut. This address is the

address that the user has set up on the AccountAccount tab of the User optionsUser options  page.

Random valueRandom value – Use a unique random value.

User full nameUser full name – Use the full name of the contact person who is associated with the user who

is accessing the external catalog.

FirstnameFirstname – Use the first name of the contact person who is associated with the user who is

accessing the external catalog.

LastnameLastname – Use the last name of the contact person who is associated with the user who is

accessing the external catalog.

Phone numberPhone number  – Use the primary phone number of the contact person who is associated with

the user who is accessing the external catalog.

The user or admin won't see the extrinsic elements, because they aren't added until the user does a PunchOut.

They will automatically be inserted between the BuyerCookieBuyerCookie and BrowserFromPostBrowserFromPost elements in the cXML

setup request message. Therefore, you don't have to set them manually in the XML when you set up the external

catalog.

When you create a purchase order for a vendor, it will inherit the setting of the Send purchase order viaSend purchase order via

cXMLcXML  option from that vendor. However, the setting remains available on the SetupSetup FastTab in the HeaderHeader  view

of the purchase order, so that you can change it later as required.



When you create a purchase order from a purchase requisition that came from a PunchOut flow, all the required

line details will be filled in. You can then manually add purchase order lines or copy them from other purchase

orders. Be sure to set all required fields. These required fields include the external reference number, which is the

vendor number that will be used in the cXML message.

When you've finished filling in all the details for the purchase order, be sure to confirm it. No message is sent

unless the purchase order is confirmed. To confirm a purchase order, on the Action Pane, on the PurchasePurchase tab,

in the ActionsActions  group, select ConfirmConfirm .

After the purchase order is confirmed, you can view the status of the confirmation through the Purchase orderPurchase order

confirmationsconfirmations  journals. On the Action Pane, on the PurchasePurchase tab, in the JournalsJournals  group, select PurchasePurchase

order confirmationsorder confirmations .

Each purchase order can have many confirmations. Each confirmation is marked with an incremental number. In

the following illustration, the purchase order is 00000275, and the confirmation is 00000275-1. This numbering

reflects standard Supply Chain Management functionality, where changes in a purchase order, and therefore the

type of cXML message that should be sent to the vendor, are identified based on the confirmation. As the

illustration shows, the Purchase order confirmationsPurchase order confirmations  page also includes Order send statusOrder send status  and OrderOrder

request vendor statusrequest vendor status  fields. For more information about the various status values that you might see on this

page, see the Monitor purchase order requests section later in this topic.



To view more information about the document, select Purchase order requestPurchase order request above the grid.

The Purchase order requestPurchase order request page includes two grids. The grid in the upper part of the page has one record

for each purchase order that is marked for sending. The grid on the Purchase order request histor yPurchase order request histor y  tab in

the lower part of the page might have several records for the selected purchase order, to indicate the status of

each confirmation. The following illustration shows purchase order 00000275 in the upper grid and document

00000275-1 in the grid on the Purchase order request histor yPurchase order request histor y  tab.

If the batch job is set up and running, the document will be sent. You can view the status change after the

document has been sent. In the following illustration, the Order send statusOrder send status  field is set to Sent. The OrderOrder

request vendor statusrequest vendor status  field is set to Acknowledged to indicate that the vendor received the document, and

was able to read it and store it in its system. The grid on the Purchase order request histor yPurchase order request histor y  tab shows the

time when the document was sent. For more information about the various status values that you might see on

this page, see the Monitor purchase order requests section.



 

  

Schedule the Purchase order request batch job

Monitor purchase order requests
View the status of a purchase orderView the status of a purchase order

To activate the batch job for sending purchase order requests, go to Procurement and sourcing > Setup >Procurement and sourcing > Setup >

cXML Management > Purchase order requestcXML Management > Purchase order request, and then, on the Action Pane, on the Purchase orderPurchase order

requestrequest tab, in the BatchBatch group, select Submit jobSubmit job to open the Purchase request prepare and sendPurchase request prepare and send dialog

box. You can use this dialog box to set up the recurrence, just as you usually do for batch jobs in Supply Chain

Management. Select an interval, based on your order volume. Although you can run the batch job every minute,

it's probably best to send batches throughout the business day, based on order receipt windows that match your

vendors' schedules.

For example, your vendor has a policy that states that all orders that are received by 1 PM will be shipped on the

same day. In this case, you might have to run the batch only a few times during the morning to communicate

any orders that you have. The remaining orders will then be sent the next day. This decision is purely a business

decision. You can review it and set the parameters for it accordingly.

The process will look for purchase order request documents that have a status of Waiting. If you have an order

that you must send to a vendor immediately, you can select Submit jobSubmit job and set the Batch processingBatch processing option

to No.

When orders that can be sent via cXML are confirmed, they go into Waiting status. As was described in the

Create and process a purchase order section, you can view the purchase order status on the Purchase orderPurchase order

requestrequest page. Each purchase order request can have one of several statuses, depending on its parameters and

data. This section describes the various status types and the values that they can have. This information can help

you manage issues and understand the status of your purchase orders.

The grid in the upper part of the Purchase order requestPurchase order request page might show the following status values:

Order send statusOrder send status  – This field can have one of the following values:

WaitingWaiting – The document is waiting to be sent.

SentSent – The document has been sent.

StoppedStopped – The document was marked as Stopped before it was sent. (To mark a document as

Stopped, select StopStop on the Action Pane of the Purchase requestPurchase request page.)

ArchiveArchive – The document has been purged. (To purge a document, select PurgePurge on the Action Pane of

the Purchase requestPurchase request page.)

Order request vendor statusOrder request vendor status  – This field can have one of the following values:

WaitingWaiting – The document is waiting to be sent.



View the XML for a purchase order request messageView the XML for a purchase order request message

View the details of the vendor responseView the details of the vendor response

AcknowledgedAcknowledged – The document has been acknowledged as received by the vendor. You can review

the detailed XML message that is returned from the vendor by selecting the Response XMLResponse XML  tab in the

lower part of the page.

ErrorError  – The document was sent to the vendor, but an error occurred. You can review the error

message by selecting the Response XMLResponse XML  tab in the lower part of the page.

The grid on the Purchase order request histor yPurchase order request histor y  tab in the lower part of the Purchase order requestPurchase order request page

might show the following values:

Order request typeOrder request type – This field can have one of the following values:

NewNew  – The line is marked as new immediately after the purchase order is confirmed.

UpdateUpdate – If a confirmation has already been sent and acknowledged by the vendor, the next

confirmation will be marked as Update. Updates will be sent only if the Send purchase requestSend purchase request

updatesupdates  option is set to Yes in the global cXML parameters.

DeleteDelete – If a confirmation has already been sent and acknowledged by the vendor, but the purchase

order is canceled, the confirmation that is waiting will be marked as Delete. Deletions will be sent only

if the Send purchase request deleteSend purchase request delete option is set to Yes in the global cXML parameters.

Request timeRequest time – The time when the order confirmation was created. You can compare the request time

with the order status time to determine the time between confirmation and vendor acknowledgment.

Order send statusOrder send status  – This field is the same as the Order send statusOrder send status  field in the upper part of the

page. It's repeated here to make it easier to view the status at the confirmation level. If the OrderOrder

request typerequest type field is set to New, and the purchase order is reconfirmed before a confirmation is sent, the

Order send statusOrder send status  field is set to Archive.

Order status timeOrder status time – The time when the purchase order request history record was last updated. (The

updates include status changes.)

Order request vendor statusOrder request vendor status  – This field is the same as the Order request vendor statusOrder request vendor status  field in

the upper part of the page. It's repeated here to make it easier to view the status at the confirmation level.

Re-submit timeRe-submit time – The time when the record was resubmitted.

Re-submit countRe-submit count – The number of times that the record has been resubmitted. A high number indicates

multiple failures, and therefore might indicate an issue with either your data setup or your vendor's data

setup.

To view the XML for the purchase order request message, select the Request XML textRequest XML text tab at the bottom of the

Purchase order requestPurchase order request page. The information on this tab can be helpful during testing or error validation. To

make the information easier to read, you can view it as a formatted message. Copy the contents of the tab to a

text file, and then view it in an XML editor.

To view the content of a vendor acknowledgment or error response, select the Response XMLResponse XML  tab at the

bottom of the Purchase order requestPurchase order request page.
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Use external catalogs for PunchOut e-procurement
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By using external catalogs for PunchOut e-procurement, you don't have to maintain information about your

vendors' products in your own master data. Instead, the shopping cart on a vendor's website is converted to

requisition lines that have the correct product information.

You should avoid maintaining the descriptions and prices of your vendors’ products in your own product master

data. Instead, use external catalogs for PunchOut e-procurement. Then, when employees create requisitions,

they can “punch out” to a vendor’s external catalog site (in other words, they leave your system and go to the

vendor’s site). The products that are added to the shopping cart on the vendor’s website can then be converted

to requisition lines. Therefore, you get the correct product information: product ID, name, price, and so on.

To use external catalogs, an employee must create a requisition on the My purchase requisitionsMy purchase requisitions  page.

The employee who creates a requisition is referred to as the preparer of the requisition. As a preparer, you can

complete the following tasks.

Use the External catalogsExternal catalogs  line action to open a page that includes all external catalogs that are available for the

specified requester, buying legal entity, and receiving operating unit.

Depending on your permissions, change the requester, buying legal entity, and receiving operating unit. A

change in those values might change the list of external catalogs that are available to a requester. The external

catalogs that are available depend on the current active purchasing policies for the buying legal entity or the

receiving operating unit. These policies can allow or prevent access to specific procurement categories.

Therefore, the list of external catalogs that are mapped to these procurement categories can be affected.

For more information about policies, see Purchasing policies overview.

To find external catalogs for specific procurement categories, enter text in the catalog search field.

To add products from a vendor’s external catalog on the vendor’s website, click the external catalog. Then add

products to the shopping cart, and check out. The shopping cart lines will be transferred to Microsoft

Dynamics 365.

If there are multiple options for procurement categories, select the correct procurement category before you

add the lines to the requisition. After lines have been added to a requisition, you can add more lines without

using external catalogs. Alternatively, you can continue to use external catalogs to add lines.

When the requisition is ready, use the WorkflowWorkflow  > SubmitSubmit action to submit it for approval.

Set up an external catalog for PunchOut e-procurement

Purchasing cXML enhancements

Can you tell us about your documentation language preferences? Take a short survey.
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Prerequisites

This topic provides information about the Vendor collaborationVendor collaboration mobile workspace. This workspace helps your

vendors stay up to date about the purchase orders that have been sent to them for approval. They can also view

information about new and updated purchase orders and contacts.

This mobile workspace is intended to be used with the Finance and Operations mobile app.

The Vendor collaborationVendor collaboration mobile workspace keeps vendors informed about new purchase orders, so that

they can view purchase orders and then respond to them in the web client.

The mobile workspace should be used as a supplement to the vendor collaboration web interface, not a replacement for

it.

Your vendors can use the Vendor collaborationVendor collaboration mobile workspace to view new purchase orders that are sent

to them for approval. It shows purchase order information, such as products, quantities, and requested delivery

dates. Price information is also available, depending on the configuration of each vendor.

A user who signs in as a vendor will see which purchase orders have been responded to, and which purchase

orders are still awaiting customer action. For example, a purchase order might be awaiting customer action

because the vendor suggested another delivery date, but the customer hasn't yet agreed to that date. The

vendor will also see a list of purchase orders that have been confirmed but haven't yet been delivered.

To respond to a purchase order, the vendor must use the vendor collaboration web interface that is available in

the web client. There, the vendor can also get more information about the order, such as document attachments,

the delivery address per line, and charges that are associated with the vendor.

Vendors that have a special security role can see which contact persons are registered for a vendor account. The

same security role lets a vendor view the status of any user request that has been submitted.

The vendor collaboration web interface in the web client must be used to create new contacts and submit new

user requests.

The Vendor collaborationVendor collaboration mobile workspace lets a vendor perform these tasks:

View new purchase orders that are sent to the vendor.

View purchase orders that the vendor has responded to, and that are awaiting customer action.

View purchase orders that have been confirmed but haven't yet been fully received.

View contact person information that is registered for the vendor account. (This task requires an additional

security role.)

View information about a user request that was submitted by the vendor, and follow the status of the

request. (This task requires an additional security role.)

The prerequisites vary, depending on the version of Microsoft Dynamics 365 that has been deployed for your

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/vendor-collaboration-mobile-workspace.md


Prerequisites if you use Supply Chain ManagementPrerequisites if you use Supply Chain Management

Prerequisites if you use Microsoft Dynamics 365 for Operations version 1611 with Platform update 3 or laterPrerequisites if you use Microsoft Dynamics 365 for Operations version 1611 with Platform update 3 or later

P REREQ UISIT EP REREQ UISIT E RO L ERO L E DESC RIP T IO NDESC RIP T IO N

KB 3216943 must be implemented if
you're using Platform update 3.

System administrator KB 3216943 is a binary update that is
required if you're using Platform
update 3. To implement this KB, the
system administrator must follow
these steps.

KB 4013633 must be implemented. System administrator KB 4013633 is an X++ update or
metadata hotfix that contains the
Inventor y on-handInventor y on-hand mobile
workspace. To implement KB 4013633,
your system administrator must follow
these steps.

The Vendor collaborationVendor collaboration mobile
workspace must be published.

System administrator See Publish a mobile workspace.

The vendor user must have access to
the vendor collaboration web interface
in the web client and must set up a
vendor collaboration user.

Purchasing professionals and the
system administrator

Follow the steps in the following topics
to set up and work with the vendor
collaboration web interface.

organization.

If Supply Chain Management has been deployed for your organization, the system administrator must publish

the Vendor collaborationVendor collaboration mobile workspace. For instructions, see Publish a mobile workspace.

If Microsoft Dynamics 365 for Operations version 1611 with Platform update 3 or later has been deployed for

your organization, the system administrator must complete the following prerequisites.

1. Download KB 3216943 from
Microsoft Dynamics Lifecycle
Services (LCS).

2. Install the binary update, which
is delivered as a deployable
package. For information about
how to apply a deployable
package, see Apply a
deployable package.

1. Download the metadata hotfix
from LCS.

2. Install the metadata hotfix.

3. Create a deployable package
that contains the SCMMobileSCMMobile
model, and then upload the
deployable package to LCS.

4. Apply the deployable package.

Use vendor collaboration to
work with external vendors

Manage vendor collaboration
users

Set up and maintain vendor
collaboration

Use vendor collaboration to
work with customers in Supply
Chain Managements
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Download and install the mobile app

Sign in to the mobile app

Use the Vendor collaboration mobile workspace

Download and install the Finance and Operations mobile app:

For Android phones

For iPhones

1. Start the app on your mobile device.

2. Enter your Microsoft Dynamics 365 URL.

3. The first time that you sign in, you’re prompted for your user name and password. Enter your credentials.

4. After you sign in, the available workspaces for your company are shown. Note that if your system

administrator publishes a new workspace later, you will have to refresh the list of mobile workspaces.

When you select the Vendor collaborationVendor collaboration workspace, you’ll see the following options.

https://go.microsoft.com/fwlink/?linkid=850662
https://go.microsoft.com/fwlink/?linkid=850663
file:///T:/eiye/ac1a/dynamics365/supply-chain/procurement/media/pull-to-refresh-list-of-workspaces.png


ContactsContacts

User requestsUser requests

Purchase orders ready for reviewPurchase orders ready for review

The Vendor collaborationVendor collaboration workspace includes the following pages.

The ContactsContacts  page lets you see all the contacts that have been set up for the vendor account. It shows the

contact person's name, primary email address, and user alias, if the contact person has an alias. This page also

shows whether the contact person's user account is active. When you select a contact, you see contact details,

such as the legal entities that the person is a contact for. You also see contact information, such as a telephone

number or an alternative email address.

The User requestsUser requests  page lets you see all the user requests that you've submitted via the vendor collaboration

web interface. You can also follow the status of those requests. When you select a user request, you can see what

was requested, add or inactivate a user, change security, and see which security roles were requested for the

user.

The Purchase orders ready for reviewPurchase orders ready for review  page lets you see all the purchase orders that the customer has sent,

but that haven't yet been responded to. You can view selected information about the order, such as which

products were requested and when those products should be delivered. Price information is also available,

depending on the configuration of the vendor.

You can also see whether the purchase order has notes or attachments. However, to open notes and

attachments, you must use vendor collaboration web interface in the web client. Select Purchase order linePurchase order line to

see all the lines together with their details. For each line, an indicator will show whether there are notes or



Awaiting customer actionAwaiting customer action

Open confirmed ordersOpen confirmed orders
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attachments, or whether the delivery address differs from the delivery address that is shown on the header.

To respond to the purchase order, you must use the vendor collaboration web interface in the web client.

The Awaiting customer actionAwaiting customer action page lets you find purchase orders that you or another person in your

company who has access to vendor collaboration has responded to. The purchase orders are visible in this list

only if the customer must take one of the following actions on the purchase order :

If the purchase order was rejected, the customer must either update or cancel the original order, and then

send it again. When the purchase order is sent again, it no longer appears on the Awaiting customerAwaiting customer

actionaction page.

If the purchase order was accepted with changes, the customer must either update the original order and

then send it again for review, or update the order per the requested changes and then confirm it immediately.

In both cases, the purchase order no longer appears on the Awaiting customer actionAwaiting customer action page.

If the purchase order was accepted but still appears on the Awaiting customer actionAwaiting customer action page, the purchase

order wasn't automatically confirmed when it was accepted. It's now waiting for a purchasing agent to

change the order status to ConfirmedConfirmed. Typically, a purchase order is considered an agreement between the

customer and the vendor as soon as the vendor accepts the order. Therefore, the update to ConfirmedConfirmed

status is usually just a formality.

When you select a purchase order, additional details appear about the response. You can see the line details and

response for every line. The line status shows which of the following responses has been given:

Accepted

Rejected

Accepted with changes

Substituted/Substitute

Split into schedule/Schedule line

Note that the Deliver ingDeliver ing field is set to either YesYes  or NoNo to indicate whether the lines will be delivered. A line

might not be delivered because for the following reasons:

The line was rejected.

A substitution was made, and the original line isn't expected to be delivered as requested in the received

order.

The line was split into multiple schedule lines, and the original line isn't expected to be delivered as requested

in the received order.

Any changes that have been made to the order line response are shown. However, uploaded notes and

attachments aren't shown. To view notes and attachments, you must use the vendor collaboration web interface

in the web client.

When the purchase order is confirmed by the customer (that is, the status of the purchase order is changed to

ConfirmedConfirmed), it appears in the open confirmed order. It will remain in the list until it's registered as received by

the customer.
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This topic explains how to approve vendors for specific procurement categories in Dynamics 365 Supply Chain

Management. When a purchase requisition is created, there may be a requirement to select an approved or

preferred vendor, depending on how the purchasing policies are set up. This procedure shows you how to

specify that a vendor is approved or preferred for a specific procurement category. This task would usually be

carried out by a procurement professional. You can use this procedure in demo data company USMF.

1. In the navigation pane, go to Modules > Procurement and sourcing > Vendors > All vendorsModules > Procurement and sourcing > Vendors > All vendors .

2. Select the vendor that you want to set as an approved or preferred vendor for a category.

3. On the Action Pane, select GeneralGeneral .

4. Select CategoriesCategories .

5. Select Add categor yAdd categor y .

6. In the Categor yCategor y  field, select OFFICE AND DESK ACCESSORIES (OFFICE AND DESK ACCESSORIES)OFFICE AND DESK ACCESSORIES (OFFICE AND DESK ACCESSORIES) .

7. In the Vendor categor y statusVendor categor y status  field, select PreferredPreferred. It's possible to specify more than one preferred

vendor for a category.

8. Select SaveSave.

9. In the navigation pane, go to Modules > Procurement and sourcing > Procurement categoriesModules > Procurement and sourcing > Procurement categories .

10. In the tree, select CORP PROCUREMENT CATEGORIES\OFFICE AND DESK ACCESSORIESCORP PROCUREMENT CATEGORIES\OFFICE AND DESK ACCESSORIES .

11. Expand the VendorsVendors  section. Check if the vendor that you selected appears as a preferred vendor for the

Office and desk accessories category. If you're running this procedure as a task guide, you may have to select

the UnlockUnlock button to be able to scroll down to the list of vendors. It's also possible to add preferred and

approved vendors on this page.

12. In the tree, expand OFFICE AND DESK ACCESSORIESOFFICE AND DESK ACCESSORIES  and select ScissorsScissors .

13. Select NoNo in the Inherit vendors from parent categor y:Inherit vendors from parent categor y: field.

14. Select YesYes  in the Inherit vendors from parent categor y:Inherit vendors from parent categor y: field.

Can you tell us about your documentation language preferences? Take a short survey.
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This procedure shows you how to approve vendors for specific products. This allows you to control which

vendors can be used when the product is added to a purchase order. You can use this procedure in demo data

company USMF, or on your own data. This task would typically be carried out by a Purchasing manager.

1. In Navigation Pane, go to Modules > Product information management > Products > ReleasedModules > Product information management > Products > Released

productsproducts .

2. In the list, find and select the desired record.

3. In the list, click the link in the selected row.

4. Expand the PurchasePurchase fastTab. If there is a primary vendor shown in the VendorVendor  field, then you need to add

this vendor as an approved vendor in the following steps. Make a note of the vendor number, if one is shown.

5. On the Action Pane, click PurchasePurchase.

6. Click SetupSetup.

7. Click AddAdd.

8. In the Vendor field, enter or select a value. Select the approved vendor. At least one of the lines has to be the

primary vendor if there was one in the product record. If you made a note of the vendor number earlier,

select it here.

9. In the ExpirationExpiration field, enter a date. Choose a date a that is a few months ahead.

10. Click AddAdd.

11. In the VendorVendor  field, enter or select a value.

12. In the ExpirationExpiration field, enter a date. Choose a date that is different than the previous expiration date.

13. Close the page.

14. On the Action Pane, click Approved vendorsApproved vendors .

15. In the ExpirationExpiration field, enter a date. This date acts as a filter so you can see who the approved vendors are,

up to a certain date.

16. Close the page.

17. On the Action Pane, click Effective periodEffective period.

18. In the Show vendors expired byShow vendors expired by  field, enter a date. You can use this page to identify vendors where the

approval status will expire after a certain date.

19. Close the page.

20. Click EditEdit.

21. In the Approved vendor check methodApproved vendor check method field, select an option. This field allows you to select the policy for

what should happen if the product is added to a purchase order line where the vendor is not an approved

vendor.

22. Click SaveSave.

23. Close the page.

24. Close the page.

25. In Navigation Pane, go to Modules > Procurement and sourcing > Vendors > Vendor/itemModules > Procurement and sourcing > Vendors > Vendor/item

relations > Approved vendor list by itemrelations > Approved vendor list by item. This page gives you an overview of all products and the

approved vendors.

26. Close the page.

27. In Navigation Pane, go to Modules > Procurement and sourcing > Vendors > All vendorsModules > Procurement and sourcing > Vendors > All vendors . You can

also start from a vendor and then go to the list of approved products for that vendor account.

28. In the list, find and select the desired record.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/tasks/approve-vendors-specific-products.md
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29. On the Action Pane, click ProcurementProcurement.

30. Click Approved vendor list by vendorApproved vendor list by vendor .

31. Close the page.

32. Close the page.
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Learn how to search for vendors based on specific criteria. This example shows you how to search for vendors

that are approved for a particular procurement category and have their primary address in a specific country.

You can run this procedure in demo data company USMF, or on your own data. This task would usually be

carried out by a procurement professional.

1. Go to Procurement and sourcing > Vendors > Vendor search.

2. Click on the Plus icon to open the Procurement category selection page.

3. In the tree, select 'CORP PROCUREMENT CATEGORIES\OFFICE MACHINES'.

4. Click Add.

5. Click OK.

6. In the Country/region field, type a value.

7. Click OK.

If you're running this procedure as a task guide, you may have to click the Unlock button before you

can select the correct node. If you're not using USMF, select one of the categories that you have.

It's possible to select more than one category here. If you do so, the search will find all the vendors

that are approved for at least one of the categories.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Grant permission to enter purchase requisitions on behalf of another
worker

View preparers who have permission to create purchase requisitions
for a selected worker
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This topic explains how to grant workers permission to prepare purchase requisitions on behalf of other

workers. In other words, a purchase requisition "preparer" can create a requisition for another "requester." The

procedure also shows how to grant a worker permission to order items and services in different legal entities or

operating units. Typically, these tasks are performed by a purchasing manager. You can use this procedure either

on data for the USMF demo company or on your own data.

1. In the navigation pane, go to Modules > Procurement and sourcing > Setup > Policies > PurchaseModules > Procurement and sourcing > Setup > Policies > Purchase

requisition permissionsrequisition permissions . Make sure that the Current viewCurrent view  field is set to By preparerBy preparer . The list in the left

pane shows the people who can be granted permission to prepare requisitions on behalf of other people.

2. Select the person to grant permission to (the preparer).

3. Select AddAdd.

4. Find and select the person to add as a requester.

5. In the EffectiveEffective field, enter a date.

6. In the ExpirationExpiration field, enter a date.

The requester is the person that the preparer can create requisitions on behalf of.

In the AuthorizationAuthorization field, select SpecificSpecific if the preparer should be able to create purchase

requisitions on behalf of the selected worker. Select Repor tingRepor ting if the preparer should also be able to

create purchase requisitions on behalf of all workers who report to that worker.

1. In the Current viewCurrent view  field, select By requesterBy requester . This view shows a list of preparers who have been granted

permission to create purchase requisitions on behalf of a selected worker.

2. Use the Quick Filter to find the worker that you just added as the requester.

3. Select the requester. The Preparer list shows the people who have permission to order items on behalf of the

requester who is selected in the left pane. You can add additional preparers here. This view also lets you grant

the requester permission to create requisitions in legal entities and operating units that aren't that person's

primary legal entity or operating unit.
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This procedure shows how to set up a project resource. This task uses the USMF data set.

1. Go to Project management and accounting > Project resources > Resources list.

2. Click New resource.

3. In the Worker field, enter or select a value.

4. In the Calendar field, enter or select a value.

5. In the Period code field, enter or select a value.

6. Click Create.

7. Click Cost prices.

8. Click Cost price - hour.

9. Click New.

10. In the Effective date field, enter a date.

11. In the Cost price field, enter a number.

12. Click Save.

13. Close the page.

14. Click Sales prices.

15. Click Sales price - hour.

16. Click New.

17. In the Effective date field, enter a date.

18. In the Pricing field, enter a number.

19. In the Valid for field, select an option.

20. Click Save.

21. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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This procedure shows you how to create and submit the budget for a project.

When you create a project budget, you can enter estimated revenues and costs for a project, and then use those

to control actual project transactions. In project budgeting, all original budgets and revisions must be sent to

project workflow for approval. Workflow gives you increased control over the process and creates a change

history record.

This task was created using the USSI data set.

1. In the Navigation paneNavigation pane, go to Modules > Project management and accounting > Projects > AllModules > Project management and accounting > Projects > All

projectsprojects .

2. In the list, find and select the desired record.

3. In the list, click the link in the selected row.

4. On the Action PaneAction Pane, click PlanPlan.

5. Click Project budgetProject budget.

6. In the Descr iptionDescr iption field, type a value.

7. Expand the CostCost fastTab.

8. Click NewNew .

9. In the Transaction typeTransaction type field, select an option.

10. In the Categor yCategor y  field, enter or select a value.

11. In the Original budgetOriginal budget field, enter a number.

12. Expand the RevenuesRevenues  fastTab.

13. Click NewNew .

14. In the list, mark the selected row.

15. In the Transaction typeTransaction type field, select an option.

16. In the Categor yCategor y  field, enter or select a value.

17. In the Original budgetOriginal budget field, enter a number.

18. Click SaveSave.

19. Click WorkflowWorkflow .

20. Click SubmitSubmit.

21. In the CommentComment field, type a value.

22. Click SubmitSubmit.
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This procedure provides information about revising a project budget. You can revise a project budget as many

times as necessary, however you can't see the amount of an individual revision if the budget has been revised

more than one time.

This task uses the SSI data set.

1. Go to Project management and accounting > Projects > All projects.

2. In the list, find and select the desired record.

3. In the list, click the link in the selected row.

4. On the Action Pane, click Plan.

5. Click Project budget.

6. Click New revision.

7. Expand the Costs section.

8. In the Revision amount field, enter a number.

9. Click Save.

10. Click Workflow.

11. Click Submit.

12. In the Comment field, type a value.

13. Click Submit.
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Product definition

Distribution, export, and import of product data

Effective November 2020:

Common Data Service has been renamed to Microsoft Dataverse. For more information, see Power Automate Blog.

Some terminology in Microsoft Dataverse has been updated. For example, entity is now table and field is now column.

For more information, see Terminology updates.

This topic will be updated soon to reflect the latest terminology.

This topic provides information about product information management. Product information management

works with a shared product definition, categorization, and identifiers across all legal entities, and also specific

configurations of a product, to fit into the business processes.

Product information is the backbone of supply chain and commerce applications across all industries. It refers to

processes and technologies that focus on centrally managing information about products (for example, across

supply chains). It's crucial that shared product definitions, documentation, attributes, and identifiers be used. In

the various modules of a business solution, product-specific information and configuration are required in order

to manage the business processes that are related to specific products, product families, or product categories.

A product is primarily defined by a product number, name, and description. However, other data is also required

in order to describe a product or service:

Product type: Item or service

Product subtype: Distinct products or product masters

Definition of the product variant model:

Product dimensions and dimension groups

Product nomenclature

Product configuration models

Association of the product with one or more categories

Definition of the product and category attributes

Product images

Attachments

Units of measure and related conversions

Translations for all names and descriptions

The product definition can be created in Supply Chain Management. It can also be imported from product

lifecycle management (PLM), product data management (PDM), or product information management (PIM)

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/product-information.md
https://aka.ms/PAuAppBlog
https://go.microsoft.com/fwlink/?linkid=2147247


Product masters and product variants

Configuration technologies

Product variant model definition workspace

Released products

systems. When more than one instance of Supply Chain Management is used, one instance is typically used as

the master of the product data for all other instances. This approach is supported by a large set of data entities

that enable the export and import of product definition data from one instance to another.

To support the distribution of product data to many instances, Supply Chain Management lets you use Microsoft

Dataverse. The product definitions can be exported from an instance of Supply Chain Management to Microsoft

Dataverse. The product definitions can then be used to provision other business applications, such as Dynamics

365 Sales, with product data.

Note that, in dynamic and agile organizations, product information data changes every day. Therefore,

maintenance of accurate and actual product data is a critical business process on its own.

In an agile world, where products must be quickly adapted to customer requirements, product definitions

specify a set of products instead of distinct products. In Supply Chain Management, those generic products are

known as product masters. Product masters hold the definition and rules that specify how distinct products are

described and behave in business processes. Based on these definitions, distinct products can be generated.

These distinct products are known as product variants.

A product master is associated with a product dimension group and a configuration technology to specify the

business rules. The product dimensions (Color, Size, Style, and Configuration) are a specific set of attributes that

can be used throughout the application to define and track specific behaviors of the related products. These

dimensions also help users search for and identify the products.

You can choose among three configuration technologies:

The predefined variants are defined by predefined product dimensions. The variant definition includes the

definition of a specific valid combination of dimensions, such as Color, Style, and Size. Each combination

produces a distinct product variant.

The dimension-based configuration is typically used in manufacturing scenarios and lets you use the

Configuration dimension in the definition of the bills of materials (BOMs). After a specific configuration is

selected, the system uses the subset of BOM lines that are valid for that configuration for planning and

production. This concept is also known as global BOM, because one shared BOM is used for all

configurations of a product.

The constraint-based configuration uses a product configuration model to describe all possible attributes and

components that are required in order to describe all possible variants of a product in a single model. The

constraints of combinations of attributes can be described through regular expressions or table-based

constraints. Configuration models and configurators become more important in product information

management and are used across all industries.

When you plan the implementation of Supply Chain Management, it's very important that you choose the

correct configuration technology for a business process. A product can't be converted from one model to

another after implementation.

The Product var iant model definitionProduct var iant model definition workspace gives an overview of the product masters. It also shows the

status of the release of masters and related variants to specific legal entities.

The products that are released to a specific legal entity are known as released products. Products can be



Released product maintenance workspaceReleased product maintenance workspace

Manually creating a new released productManually creating a new released product

NOTENOTE

released in bulk to one legal entity or many legal entities at a time. Because various properties and attributes of

the products might have to be added per legal entity, the Released product maintenanceReleased product maintenance workspace lets you

monitor and complete the recently released products in each legal entity, or in the suborganizations of a legal

entity.

You can configure the Released product maintenanceReleased product maintenance workspace from the Configure my workspaceConfigure my workspace

menu item. Select a category hierarchy and category to filter the workspace by. To adjust the relevant product

data in the workspace, you can also define, in days, the time fences for Recently released productsRecently released products  and

Stopped released productsStopped released products .

The workspace consists of a summary of tiles and two lists. The Open casesOpen cases  list shows product change cases

that have products in the selected product category hierarchy that aren't completed and closed. The RecentlyRecently

releasedreleased list shows products that have been released within the time fence that is set in the workspace

configuration. For each item in the list, validation is run, and the validation status is shown. This status might

indicate that the required configurations for the legal entity hasn't been completed. From the list, you can

directly access the Released product detailsReleased product details , Product attr ibute maintenanceProduct attr ibute maintenance, Product categor yProduct categor y

maintenancemaintenance, Default order settingsDefault order settings , and Text translationsText translations  pages to complete the required configuration

of the product.

You can manually create a released product in a single run, depending on the organization's business processes

and any rules about whether this function should be used. This function creates a new product and

automatically releases it to the current legal entity. To create a new product, click Released productsReleased products  in the

Released product maintenanceReleased product maintenance workspace or on the Released productReleased product list page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Unique product number/product ID

Item number and product dimensions

Effective November 2020:

Common Data Service has been renamed to Microsoft Dataverse. For more information, see Power Automate Blog.

Some terminology in Microsoft Dataverse has been updated. For example, entity is now table and field is now column.

For more information, see Terminology updates.

This topic will be updated soon to reflect the latest terminology.

This topic provides information about the various types of product identifiers and explains how you can add

product identifiers in your product data.

When you work with products on the shop floor or in a warehouse in Microsoft Dynamics ERP or Microsoft

Dynamics CRM, you must have a good strategy for identifying those products and product variants.

In Dynamics 365 Supply Chain Management, the primary identifier for a product is the product number (that is,

the unique product ID). This number can be automatically generated by a number sequence or manually

associated with a product. For product variants, the numbers can be defined through the product nomenclature

template.

In many cases, the product number isn't originally created in Dynamics 365 Supply Chain Management. Instead,

it's associated with a product in a product lifecycle management (PLM) system or a product data management

(PDM) system. In this case, you use data entities to import the products and product variants. Supply Chain

Management then uses the numbers in all operations.

When you implement Supply Chain Management, you should give special consideration to your strategy for

product numbers. A good numbering system improves logistics flows and helps prevent errors. A good product

identifier has a maximum of 15 characters. Ideally, it has fewer than 10 characters and includes no more than

five classifying characters. You can also use search names to enable quick searches. A search name is an

additional name that represents the classifications of a product.

When you use Microsoft Dataverse, the product number in Supply Chain Management is also the product

number in Microsoft Dataverse. Product variants are synchronized to Dataverse as distinct products.

The item number is the product identifier that is used by a specific legal entity. Ideally, the item number should

be identical to the product number. If the nomenclature differs per legal entity, it becomes difficult to follow a

product throughout the supply chain, and burdensome relabeling and referencing processes are introduced. For

compatibility with older versions (that is, with Microsoft Dynamics AX 2009 and earlier), we have preserved this

model. However, we recommend that you eliminate identifiers that are specific to legal entities whenever you

can, and that you use the unique product number as the primary identifier instead.

Additionally, a product variant can't be uniquely identified by an item number. It always requires the

combination of an item number and all the product dimensions that are defined on the product master. This

requirement can become cumbersome and can slow down the identification processes. For this reason too, we

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/product-identifiers.md
https://aka.ms/PAuAppBlog
https://go.microsoft.com/fwlink/?linkid=2147247
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Product name and description

Product and item search names

External product identifiers (Customer and vendor identifiers)

recommend that you use the unique product number instead the item number whenever you can.

Many pages still have the item number and product dimensions as the primary identifiers. However, the product

numbers can be used for searches. At Sales and marketingSales and marketing > SetupSetup > SearchSearch > Search parametersSearch parameters , you

can change the search lookup so that it uses product numbers instead of item numbers as the primary search

strategy. If you set the Enable lookup for product searchEnable lookup for product search option to YesYes , the lookup will show not only

product masters but product variants. For more information, see Search for products and product variants

during order entry.

Additionally, you will be able to search and filter on the product number, the product name and description, and

the product dimension IDs of the product variant. When you select a variant, the related item number and all

product dimension IDs will be selected. Therefore, you can more easily find and select the correct variant. This

setting is highly recommended if you use product variants and the unique product number as the primary

identifiers for products. The only exception might be the fashion industry, where the business processes often

require that you select the master before you select a variant. You should carefully evaluate this option before

you implement the numbering system.

The item number for a product can't be changed once one or more transactions exist for that product.

The product name and description are the human-readable identifiers of a product and can be maintained in

many languages. By default, the Supply Chain Management client shows all product information in the default

company language, not in the user's language. However, translated product names and descriptions are used in

all communication with customers and vendors. The translations are based on the language code of the

customer and vendor accounts.

For product variants, the product name can be generated through a product nomenclature template. Because

there is no requirement that product names be unique, you might find multiple products that have the same

name.

Supply Chain Management offers a secondary search name for products and also for items (released products).

This search name doesn't have to be unique, and it can be changed after a product or product variant is created.

We recommend that you use the search name to search for products by categories. The search names enable

quick searches, especially in sales and purchase processes.

The search name can also contain a customer or vendor product ID, or some other external product ID, if this

external ID is the primary search criterion for a product.

For released products, you can maintain the item numbers, item names, and item descriptions that the customer

or vendor uses. The references are shown on external documents, such as sales orders, purchase orders, packing

slips, and invoices. In the current version of Supply Chain Management, the external references aren't shown on

core operations pages. The only exception is the vendor item number. This number is shown in the ProductProduct

informationinformation dialog box if a default vendor is defined for the released product.

You can maintain the external product identifiers by released product, released product variant, customer or

customer group, or vendor or vendor group.

On the Released productsReleased products  page, follow one of these steps.
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External item number The customer's item number The vendor's item number

Description The name that the customer associates
with the item

The name that the vendor associates
with the item

External item text The customer's item description The vendor's item description

Bar codes

GTIN codes

For customers, on the SellSell  tab, in the Related informationRelated information group, select External item descr iptionExternal item descr iption.

For vendors, on the PurchasePurchase tab, in the Related informationRelated information group, select External item descr iptionExternal item descr iption.

On the External item descr iptionsExternal item descr iptions  page, you can associate the customer's or vendor's item number with a

released product. This association must be done for each legal entity. The following information can be captured.

Unfortunately, the labels are slightly misleading in the current version of Supply Chain Management. However,

these labels might be changed in a future version.

If many customers or vendors use the same item numbers (as in the case of a purchase association or a

commerce group, for example), you can create groups of customer or vendors to simplify the maintenance of

external product information.

For customer groups, go to SalesSales  > SetupSetup > ItemsItems > External item descr iptionExternal item descr iption to create and maintain

the groups and the related item numbers. To associate customers with a group, go to Accounts receivableAccounts receivable

> CustomersCustomers  > All customersAll customers , and then, on the Sales order defaultsSales order defaults  FastTab, specify a value in the ItemItem

- customer group- customer group field.

For vendor groups, go to Procurement and sourcingProcurement and sourcing > SetupSetup > External item descr iption groupExternal item descr iption group to

create and maintain the groups the related item numbers. To associate vendors with a group, go to

Accounts payableAccounts payable > VendorsVendors  > All vendorsAll vendors , and then, on the Purchase order defaultsPurchase order defaults  FastTab, specify

a value in the Item - vendor groupItem - vendor group field.

If you want to use a bar code scanner to identify products, the product identifier must meet the requirements of

the bar code standard that is used. Therefore, bar codes don't typically contain the raw product number but a

number that is generated specifically for the selected bar code technology. You can maintain multiple bar codes

by bar code type. You can even associate the same bar code with multiple products and then select the actual

active association when you scan a bar code.

Before you define bar codes, you can define one or more bar code setups. The bar code setups can help validate

that bar codes follow the required guidelines, and that they can therefore be effectively printed and scanned. You

can also maintain special bar codes for specific product quantities.

We recommend that you use the bar code setup to maintain Global Trade Item Number (GTIN) or International

Article Number (EAN) codes.

To maintain bar codes, on the Released productsReleased products  page, on the Manage inventor yManage inventor y  tab, in the WarehouseWarehouse

group, select Bar codesBar codes .

In e-commerce, it's crucial that all parties speak a common language and refer to products by using a common

set of identifiers. Therefore, some industries rely on the GTIN, which is a global item number system that is

facilitated by GS1.

We recommend that you maintain the GTIN as a bar code. However, you can also maintain it on the Item -Item -

https://www.gs1.org/id-keys/gtin


External codes

Data entities that are used to import and export product identifiers

EN T IT Y  N A M EEN T IT Y  N A M E IM P O RT  IDEN T IF IERSIM P O RT  IDEN T IF IERS EXP O RT  IDEN T IF IERSEXP O RT  IDEN T IF IERS C O M M EN T SC O M M EN T S

Products V2 Product number, product
search name, product
name, product description

Product number, product
search name, product
name, product description

Depending on the settings
of the entity and the
number sequence for the
product number, the
product number can be
automatically created at the
time of import.

Product variants Product number, product
search name, product
name, product description

Product number, product
search name, product
name, product description

Depending on the product
nomenclature template, the
product number can be
automatically created at the
time of import. However,
you can import any unique
product number, and that
product number doesn't
have to follow the structure
of the product
nomenclature templates.

Product translations Product name, product
description

Product name, product
description

This entity overwrites any
language. Note that when
the name or description of
a legal entity's primary
language is overwritten, the
name and description of the
product itself is changed.

GTINGTIN page. To open this page, on the Released productsReleased products  page, on the Manage inventor yManage inventor y  tab, in the

WarehouseWarehouse group, select GTIN codesGTIN codes . Note that the GTIN isn't maintained as a global number. Instead, it's

maintained by legal entity.

In Supply Chain Management, you define packaging variants in the warehouse operations by defining specific

units of measure. For example, an item might be stored in pieces, in bundles of six, in trays of 18, or in full

pallets. A specific unit of measure will be defined for each of these packaging variants. Because the GTIN is

typically related to the packaging unit of a product, the Item - GTINItem - GTIN page lets you maintain multiple GTIN

codes per product and unit of measure. However, you can't use the same GTIN code more than one time for

different items or product variants of a legal entity.

To maintain GTIN codesGTIN codes , on the Released productsReleased products  page, on the Manage inventor yManage inventor y  tab, in the WarehouseWarehouse

group, select GTINGTIN.

External codes can be defined for many entities. For example, you can define external codes to identify products

and released products. These external codes can be used to associate statistical codes or tax codes with released

products and released product variants. External codes are defined by legal entity and code type. They must be

unique by legal entity, code type, and table reference.

Unfortunately, there is no standard functionality that lets you search for products by external codes.



Released product creation
V2

Item number, product
number, item search name

Item number, product
number, item search name,
product search name,
product name

This entity can be a
challenge when number
sequences are used during
the creation of new released
products. Both the ItemItem
numbernumber  number sequence
and the Product numberProduct number
number sequence have an
influence. However, the
Item numberItem number  number
sequence is per legal entity,
whereas the ProductProduct
numbernumber  number sequence
is global. Therefore, we
don't recommend that you
use the Item numberItem number
number sequence when
you deploy new released
products. Obviously, when
the entity is used to release
an existing product, the
product number must be
given in the entity. For
more information, see the
"Product and item number
sequences" section in this
topic.

Released product variants Item number, product
dimensions, product
number

Product number, product
search name, product
name, product description,
product dimensions

Like the Product variantsProduct variants
entity, this entity can be
used to create new
products that either follow
the product nomenclature
template or use their own
product numbers for the
variant.

External item description for
customers

Customer item number,
customer item name,
customer description,
customer account

Customer item number,
customer item name,
customer description,
customer account

A group of customers (for
example, a buyer
association) can be
aggregated into one group
by using the External itemExternal item
description customerdescription customer
groupsgroups entity.

External item description for
vendors

Vendor item number,
vendor item name, vendor
description, vendor account

Vendor item number,
vendor item name, vendor
description, vendor account

A group of vendors (for
example, a sales association
or industry organization)
can be aggregated into one
group by using the
External itemExternal item
description vendordescription vendor
groupsgroups entity.

EN T IT Y  N A M EEN T IT Y  N A M E IM P O RT  IDEN T IF IERSIM P O RT  IDEN T IF IERS EXP O RT  IDEN T IF IERSEXP O RT  IDEN T IF IERS C O M M EN T SC O M M EN T S



Item Barcode Bar code Bar code Note that, at the time of
import, you must refer to a
bar code setup that is
defined in the target
system. The imported bar
code references are
validated against that bar
code setup and are rejected
if the bar codes don't match
the requirements that are
defined in that bar code
setup.

External codes for released
products

External code External code, external code
classes, item number

External codes are by legal
entity. For import, you must
refer to a defined code
class. Import the code
classes by using the
External code classes forExternal code classes for
released productsreleased products  entity.

External codes for released
product variants

External code External code, external code
classes, item number,
product dimensions

External codes are by legal
entity. For import, you must
refer to a defined code
class. Import the code
classes by using the
External code classes forExternal code classes for
released productsreleased products  entity.
This entity refers to product
variants by the item
number and product
dimensions.

External codes for released
product variants by product
number identifier

External code External code, external code
classes, product number

External codes are by legal
entity. For import, you must
refer to a defined code
class. Import the code
classes by using the
External code classes forExternal code classes for
released productsreleased products  entity.
This entity refers to product
variants by the product
number of the variant.
(From the next major
release)

GTIN Not applicable Not applicable Currently, there is no
specific entity that is used
to import and export GTIN
codes. We recommend that
you use the Item BarcodeItem Barcode
entity instead.
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Product entity common
data service identifier entity

Not applicable Item number, item search
name, product search
name, vendor item number,
customer item number,
external codes, GTIN codes,
bar codes

This entity consolidates all
identifiers into one data
model, so that one interface
can be used to easily export
all identifiers and their
related types. Use the
Product entity identifierProduct entity identifier
codecode entity to export the
identifier codes and
descriptions. Use the
Product entity identifierProduct entity identifier
scopescope entity to export
additional scope
information to an identifier,
such as the party, legal
entity, quantity, or unit.
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Product and item number sequencesProduct and item number sequences
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You can define two different number sequences:

The Product numberProduct number  number sequence for the global product number

The Item numberItem number  number sequence for the item number per legal entity

You should use the item number as a separate identifier only when you migrate different legal entities from different

sources that had different numbering systems. You should always try to use a product identifier that is unique across all

legal entities. Therefore, you should set the ManualManual option to YesYes for the Item numberItem number  number sequence. In this way,

the item number will follow the product number on creation. If Supply Chain Management isn't the leading system for

new product numbers, you should set the ManualManual option to YesYes for both the Item numberItem number  and Product numberProduct number

number sequences.

When you use the Released product creation V2Released product creation V2  entity to create products, multiple settings can affect how

the number sequences are used to create the product number and item number:

Settings of the Product numberProduct number  number sequence

Settings of the Item numberItem number  number sequence

The mapping of the item number

The mapping of the product number

The following table provides an overview of the results of import and manual creation when specific

combinations of the number sequence and field mapping settings.



Manual = No Manual = No No mapping No mapping Product
numbers use
the ProductProduct
numbernumber
number
sequence.
Item numbers
use the ItemItem
numbernumber
number
sequence.

Product
numbers use
the ProductProduct
numbernumber
number
sequence.
Item numbers
use the ItemItem
numbernumber
number
sequence.

With this
configuration,
product
numbers will
follow the
product
number
sequence and
item numbers
will follow the
item number
sequence.
However, this
configuration
won't work if
there is more
than one item
(row) to be
imported.

Manual = No Manual = Yes Auto
generate

No mapping Both product
numbers and
item numbers
use the ItemItem
numbernumber
number
sequence.

Both product
numbers and
item numbers
use the
ProductProduct
numbernumber
number
sequence.

Both product
numbers and
item numbers
will follow the
product
number
sequence.
This is the
recommende
d approach to
import bulk
products with
the Released
product
creation V2
data entity.

Manual = No Manual = Yes No mapping No mapping Both product
numbers and
item numbers
use the
ProductProduct
numbernumber
number
sequence.

Both product
numbers and
item numbers
use the
ProductProduct
numbernumber
number
sequence.

Both product
numbers and
item numbers
will use the
product
number
sequence.
However, this
configuration
won't work if
there is more
than one item
(row) to be
imported.
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Manual = Yes Not
applicable

Not
applicable

Auto
generate

You receive
the following
error
message:
"Number
sequence
can't be
detected."

According to
the ItemItem
numbernumber
number
sequence

This setting
isn't
supported for
import.
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Product entity identifier (Export all product identifiers)
The product entity identifier model was created to enable version 1.0 of Dataverse to be provisioned with all

identifiers that are used to refer to a product. To simplify this task, all identifiers are aggregated into one global

identifier table, so that they can be exported as one model. Note that this version of Dataverse doesn't use the

product identifiers model. Therefore, the Product entity common data ser vice identifier  entityProduct entity common data ser vice identifier  entity  entity and

this process have limited practical use and will likely be subject to change in the future.

The product identifier table is a global table that is populated from all reference tables of the Main legal entity

through a recurring batch job. You must select a legal entity and a product category hierarchy as the definition

of the global product master scope. Generation of the global product identifier table is limited to products that

are released to the selected legal entity and products that are members of the product hierarchy that is selected

for the Common data ser viceCommon data ser vice role in the product category hierarchy.

This process assumes that product master data is primarily maintained in one central legal entity. (However, this

legal entity can be a virtual legal entity that is used only to maintain global master data.)

Follow these steps to configure the environment.

1. Select the category hierarchy for Dataverse. On the Categor y hierarchy role associationsCategor y hierarchy role associations  page, if no

hierarchy is associated with the Common data ser viceCommon data ser vice role, you must create a new association. Select

the Common data ser viceCommon data ser vice role, and then associate the category hierarchy that represents the product

portfolio that should be synchronized to Dataverse.

2. Select the legal entity for global product master data. On the Product information managementProduct information management

parametersparameters  page, on the Product attr ibutesProduct attr ibutes  tab, select the master company where the product and

item identifiers are primarily maintained.

3. Define the identifier code types and codes that should be exported. Go to Product informationProduct information

managementmanagement > SetupSetup > Product identifier  codesProduct identifier  codes . To generate the identifier code types, select

Generate codesGenerate codes . A code type entry is generated for each type for identifier that is found in the selected

legal entity.

Note that, for bar codes, a code type is generated for each bar code setup. For external codes, a code type

is generated for each external code class.

You can now maintain the list of code types. You can change the code, name, and description. You can also

delete code types. Code types that you delete won't be used to populate the global product entity

identifier tables.

4. When you've finished defining the product identifier code types, you can create the identifiers in the

global table by starting the Create product entity identifiersCreate product entity identifiers  job on the Product entity identifierProduct entity identifier

codescodes  page. You should run this job in a batch. This job should be set up as a periodic batch job so that

the table is populated according to new entries.
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You can now use the Product entity common data ser vice identifier  entityProduct entity common data ser vice identifier  entity , Product entity identifierProduct entity identifier

codecode, and Product entity identifier  scopeProduct entity identifier  scope data entities to export the identifiers for any target system.

Search for products and product variants during order entry
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Create the new category hierarchy

Build the hierarchy

Classify the hierarchy

This procedure shows how to create a new category hierarchy and assign a commodity code hierarchy type. The

demo data company used to create this procedure is USMF. This procedure is intended for the category

manager.

1. Go to Navigation pane > Modules > Product information management > Setup > CategoriesNavigation pane > Modules > Product information management > Setup > Categories

and attr ibutes > Categor y hierarchiesand attr ibutes > Categor y hierarchies .

2. Click NewNew .

3. In the NameName field, type a value.

4. In the Descr iptionDescr iption field, type a value.

5. Click CreateCreate.

1. Click NewNew  category node.

2. In the NameName field, type a value.

3. In the CodeCode field, type a value.

4. In the Fr iendly nameFriendly name field, type a value.

5. Click NewNew  category node.

6. In the NameName field, type a value.

7. In the CodeCode field, type a value.

8. In the Fr iendly nameFriendly name field, type a value.

9. Click NewNew  category node.

10. In the NameName field, type a value.

11. In the CodeCode field, type a value.

12. In the Fr iendly nameFriendly name field, type a value.

13. Click NewNew  category node.

14. In the NameName field, type a value.

15. In the CodeCode field, type a value.

16. In the Fr iendly nameFriendly name field, type a value.

17. Close the page.

1. In the list, find and select the desired record.

2. On the Action PaneAction Pane, click Categor y hierarchyCategor y hierarchy .

3. Click Associate hierarchy typeAssociate hierarchy type.

4. Click NewNew .

5. In the Categor y hierarchy typeCategor y hierarchy type field, select an option. Select the Commodity code categor y hierarchyCommodity code categor y hierarchy

type for product classificationtype for product classification.

6. In the Categor y hierarchyCategor y hierarchy  field, click the drop-down button to open the lookup.

7. In the list, find and select the desired record.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/create-hierarchy-product-classification.md
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8. In the list, click the link in the selected row.

9. Close the page.
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This topic describes how to classify a product using category hierarchies. Use category hierarchies to classify

products for export, procurement, sales, or other purposes. This task is typically performed by a product

manager. The example uses product number M0009 in demo data company USMF.

1. Select Released product maintenanceReleased product maintenance.

2. Select All released productsAll released products .

3. In the list, find and select the desired record.

4. On the Action Pane, select ProductProduct.

5. Select Product categoriesProduct categories .

6. Select NewNew .

7. In the Categor y hierarchyCategor y hierarchy  field, enter or select a value.

8. In the Categor yCategor y  field, enter or select a value.

9. Select NewNew .

10. In the Categor y hierarchyCategor y hierarchy  field, enter or select a value.

11. In the Categor yCategor y  field, enter or select a value.

12. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.
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Nomenclature of predefined product variants

ExampleExample

This topic describes how you can set up a product number nomenclature to replace the fixed [Product master

number - Configuration - Size - Color - Style] format. The new nomenclature has a targeted format that includes

the product master number, active product dimensions, and text delimiters of your choice. You can also create a

nomenclature for product names. Finally, you can build a nomenclature to identify configurations that are

created by the constraint-based product configurator. These nomenclatures can contain attributes of your choice.

The new nomenclatures for product variant numbers and product variant names let you include segments in the

identifiers for product variants. These segments can include the product master number and name, product

dimension IDs and names, number sequences, text constants, and attributes. This functionality lets you quickly

find a specific product variant when you create a sales order or a purchase order. You create nomenclatures for

both product variant numbers and product variant names by using the Product nomenclatureProduct nomenclature page. To open

this page, click Product information managementProduct information management > SetupSetup.

Product variants are generated for product masters according to one of three configuration technologies:

Predefined variants

Constraint-based

Dimension-based

Each product variant has a number and a name, and the product variant identification nomenclatures let you

select the segments that will be included in each product variant number or name. You can select the following

segments on the Product nomenclatureProduct nomenclature page:

Product master number

Product master name

Number sequence value

Text constant

Product dimensions

Configuration ID or name

Color ID or name

Size ID or name

Style ID or name

After you define a product variant identification number nomenclature, you can associate it with a product

dimension group. All product masters that reference this product dimension group will then be assigned

product variant numbers according to the nomenclature. However, product variant name nomenclatures can't be

associated with product dimension groups. You can also assign a product variant identification nomenclature

directly to a product master. In this case, the product variants that belong to the product master will be assigned

product variant numbers and names according to the nomenclatures.

A T-shirt (TS1234) is produced in three sizes (S, M, L), four colors (Red, Green, Blue, Yellow), and two styles (Polo,

V). Therefore, 24 product variants are possible (= 3 × 4 × 2). You create a product variant number nomenclature

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/product-variant-identification-nomenclature.md


Nomenclature of constraint-based configurations

ExampleExample

Nomenclature of dimension-based configurations

ExampleExample

that has the following segments:

1. Product master number

2. Text constant: "-"

3. Color

4. Text constant: "-"

5. Size

6. Text constant: "-"

7. Style

In this case, the product variant number for a red, small, polo T-shirt will be TS1234-Red-Small-Polo.

For constraint-based configurations, you can create a dedicated nomenclature for the configuration product

dimension. You can select the following segments on the Product nomenclatureProduct nomenclature page:

Number sequence value

Text constant

Attribute value

Each component in a product configuration model can have its own configuration nomenclature. Only attributes

that belong to the component can be used. Attributes from subcomponents or user requirements can't be used.

A product configuration model has a root component that has two attributes:

Material (Plastic, Wood, Steel)

Length (10...100)

You create a configuration nomenclature that has the following segments:

1. Attribute value: Material

2. Text constant: "AAA"

3. Attribute value: Length

In this case, the configuration ID for wood material that has a length of 78 will be WoodAAA78.

For dimension-based configurations, you can create a dedicated nomenclature for the configuration product

dimension. You can select the following segments on the Product nomenclatureProduct nomenclature page:

Number sequence value

Text constant

Configuration group item

You can define a configuration nomenclature for a bill of materials (BOM).

A BOM has four BOM lines that are divided into two configuration groups:

BOM line: M0007, Standard cabinet

BOM line: M0008, High end cabinet

Configuration group: Cabinet

Configuration group: Cabinet



Nomenclature for a combination of product variants and
configurations

Example for constraint-based configurationsExample for constraint-based configurations

Example for dimension-based configurationsExample for dimension-based configurations

BOM line: M0021, Front grill cloth

BOM line: M0022, Front grill metal

Configuration group: Cabinet

Configuration group: Front grill

Configuration group: Front grill

You create a configuration nomenclature that has the following segments:

1. Configuration group: Cabinet

2. Text constant: "&"

3. Configuration group: Front grill

In this case, the configuration ID for a standard cabinet that has a cloth front grill will be M0007&M0021.

When you use either the constraint-based configuration technology or the dimension-based configuration

technology to configure product variants for a product master, the product variant numbers of the product

variants can include the nomenclature from the configuration dimension. Follow these steps to configure

variants.

1. On the Product nomenclatureProduct nomenclature page, define a product variant number nomenclature that includes the

configuration dimension.

2. Assign the nomenclature to a product dimension group that has the configuration dimension.

3. Define a configuration nomenclature for the components or BOMs that will be used to configure the product

variants.

You can also create nomenclatures for the product variant names. The product variant names can be configured

to include the configuration ID or name.

For this example, you use a product variant number nomenclature that consists of the following segments:

1. Product master number

2. Text constant "_"

3. Configuration

The configuration nomenclature consists of the following segments:

1. Attribute value: Material

2. Text constant: "AAA"

3. Attribute value: Length

You enter the following values for segments:

Product master number = M0099M0099

Material = PlasticPlastic

Length = 1212

In this case, the product variant number will be M0099_PlasticAAA12.

For this example, you use a product variant number nomenclature that consists of the following segments:

1. Product master number



Numbering conflicts

Predefined variantsPredefined variants

Constraint-based configurationsConstraint-based configurations

Dimension-based configurationsDimension-based configurations
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2. Text constant "//"

3. Configuration

The configuration nomenclature consists of the following segments:

1. Configuration group: Cabinet

2. Text constant: "&"

3. Configuration group: Front grill

You enter the following values for segments:

Product master number = D0123D0123

Cabinet = M0008M0008

Front grill = M0022M0022

In this case, the product variant number will be D0123//M0008&M0022.

In some cases, a product variant number nomenclature that you set up might not produce unique product

variant numbers. For example, the product variant numbers won't be unique if one active product dimension

isn't included in the nomenclature for a product master that uses the predefined variant configuration

technology. The way that you handle conflicts varies, depending on the configuration technology.

An error occurs if you try to manually create or automatically generate product variants, and more than one

product variant ends up with the same product variant number. To avoid this scenario, you should use all active

product dimensions in the product dimension group. Alternatively, include a number sequence to help

guarantee that the product variant numbers are unique.

Depending on the nomenclature, the system might try to assign a non-unique product variant number to a

configuration. In this case, the system uses the number sequence for the configuration dimension as the product

variant number instead, and you receive a warning. To avoid this scenario, you should include enough attributes

in the nomenclature to help guarantee unique product variant numbers. You should also make sure that the

ReuseReuse option is turned on for the component.

During one step of the configuration process, the system suggests a configuration value according to the

nomenclature. In this step, you can manually change the configuration value. When you save the configuration,

the system verifies that the configuration value is unique. If the value that you entered isn't unique, you receive

an error message. To save the configuration, you must enter a unique configuration value.

Create a product number nomenclature for predefined product variants

Create a product number nomenclature for configured product variants
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Create a product number nomenclature

Assign the nomenclature to a product master

NOTENOTE

This topic explains how to set up a product number nomenclature for predefined product variants, and how you

assign it to the appropriate product dimension group. The demo data company used to create this procedure is

USMF. The new product number nomenclature is assigned to the Color and Size product dimension group. This

task would typically be done by a product designer.

1. Select Product var iant model definitionProduct var iant model definition.

2. Select Product nomenclatureProduct nomenclature.

3. Select NewNew .

4. In the NameName field, enter a nomenclature name that helps to identify the target product dimension group, for

example, ColorSize .

5. In the Descr iptionDescr iption field, type a value.

6. Select AddAdd.

7. Select Product masterProduct master  number.

8. Select AddAdd.

9. Select Text constantText constant.

10. In the TextText field, type a value.

11. Select AddAdd.

12. Select ColorColor .

13. Select AddAdd.

14. Select Text constantText constant.

15. In the TextText field, type a value.

16. Select AddAdd.

17. Select S izeSize.

18. Close the page.

1. Select Product dimension groupsProduct dimension groups .

2. Select the S izeCol product dimensionSizeCol product dimension group.

3. Select EditEdit.

4. Select YesYes  in the Use nomenclatureUse nomenclature field.

5. In the Product var iant number nomenclatureProduct var iant number nomenclature field, enter or select a value.

6. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.
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Create a product number nomenclature

Assign the product number nomenclature to a product master

Create nomenclature for a product configuration model component

This procedure shows you how to set up a product number nomenclature for configured product variants, and

how it can be attached to a configurable product master. This procedure also demonstrates how you can build a

configuration nomenclature for a product configuration model component. The demo data company used to

create this procedure is USMF. The new product number nomenclature is assigned to the D0004 product master.

This task would typically be done by a product designer.

1. Click Product variant model definition.

2. Click Product nomenclature.

3. Click New.

4. In the Name field, type a value.

5. In the Description field, type a value.

6. Click Add.

7. Click Product master number.

8. Click Add.

9. Click Text constant.

10. In the list, mark the selected row.

11. In the Text field, type a value.

12. Click Add.

13. Click Configuration.

14. Close the page.

1. Click Product masters.

2. Use the Quick Filter to find records. For example, filter on the Product number field with a value of 'D'.

3. In the list, click the link in the selected row.

4. Click Edit.

5. Select Yes in the Use nomenclature field.

6. In the Product variant number nomenclature field, enter or select a value.

7. Close the page.

8. Close the page.

1. Click Product configuration models.

2. In the list, find and select the desired record.

3. In the list, click the link in the selected row.

4. Click Edit.

5. Select Yes in the Use configuration nomenclature field.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/create-product-number-nomenclature-product-variants_2016_11.md
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6. Click Add.

7. Click Attribute value.

8. In the list, mark the selected row.

9. In the Attribute field, enter or select a value.

10. Click Add.

11. Click Text constant.

12. In the list, mark the selected row.

13. In the Text field, type a value.

14. Click Add.

15. Click Attribute value.

16. In the list, mark the selected row.

17. In the Attribute field, enter or select a value.

18. Click Add.

19. Click Text constant.

20. In the list, mark the selected row.

21. In the Text field, type a value.

22. Click Add.

23. Click Attribute value.

24. In the list, mark the selected row.

25. In the Attribute field, enter or select a value.

26. Click Add.

27. Click Text constant.

28. In the list, mark the selected row.

29. In the Text field, type a value.

30. Click Add.

31. Click Attribute value.

32. In the list, mark the selected row.

33. In the Attribute field, enter or select a value.

34. Click Add.

35. Click Text constant.

36. In the list, mark the selected row.

37. In the Text field, type a value.

38. Click Add.

39. Click Number sequence value.

40. In the list, mark the selected row.

41. In the Number sequence field, enter or select a value.

42. Close the page.

43. Close the page.

44. Close the page.
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Create a product

Set up dimension groups
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This topic describes how to create a new shared product. It is usually carried out by a product designer. The

demo data company used to create this task is USMF.

1. In the Navigation pane, go to Modules > Product information management > Products > ProductsModules > Product information management > Products > Products .

2. Select NewNew .

3. In the Product numberProduct number  field, type a value. If a number sequence has not been set up for the product

number, it must be entered manually.

4. In the Product nameProduct name field, type a value. The product name defaults to the search name. You can change this

if needed.

5. Select OKOK.

1. Select Dimension groupsDimension groups  to open the drop dialog.

2. In the Storage dimension groupStorage dimension group field, enter or select a value. The storage dimension group determines

which storage dimensions you must enter on each transaction for the product and how it will be tracked in

inventory.

3. In the Tracking dimension groupTracking dimension group field, enter or select a value. The tracking dimension group determines

which tracking dimensions you must enter for each transaction for the product, and how it will be handled in

inventory.

4. Select OKOK.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a new product master

Select product dimension groups

Add dimension groups

Create a product master for the predefined variants. The demo data company used to create this procedure is

USMF. This procedure is intended for the product designer.

1. Go to Navigation pane > Modules > Product information management > Products > ProductNavigation pane > Modules > Product information management > Products > Product

mastersmasters .

2. Click NewNew .

3. In the Product numberProduct number  field, type a value. The number must be unique. A number sequence can be set for

the Product numberProduct number  field. In this case, the user doesn't have to enter a value.

4. In the Product nameProduct name field, type a value. Enter a descriptive product name. The value defaults to the search

name, but this can be changed by the user.

5. In the Product dimension groupProduct dimension group field, click the drop-down button to open the lookup. The product

dimension group determines which of the 4 product dimensions that can be used to create product variants.

This example uses a group with color and size.

6. In the list, find and select the desired record.

7. In the list, click the link in the selected row. The default Configuration technologyConfiguration technology  is 'Predefined variant'.

This will be used for this example.

8. Click OKOK.

1. In the Color groupColor group field, click the drop-down button to open the lookup.

2. In the list, find and select the desired record.

3. In the list, click the link in the selected row.

4. In the S ize groupSize group field, click the drop-down button to open the lookup.

5. In the list, find and select the desired record.

6. In the list, click the link in the selected row.

1. On the Action PaneAction Pane, click ProductProduct.

2. Click Dimension groupsDimension groups  to open the drop dialog.

3. In the Storage dimension groupStorage dimension group field, click the drop-down button to open the lookup. The storage

dimensions help you control how items are stored and taken from inventory. For example, a storage

dimension can include Site and Warehouse.

4. In the list, find and select the desired record.

5. In the list, click the link in the selected row.

6. In the Tracking dimension groupTracking dimension group field, click the drop-down button to open the lookup. The tracking

dimension group determines which tracking dimensions you can add to a product. For example, the batch

number and serial number are used to track inventory items.

7. In the list, find and select the desired record.

8. In the list, click the link in the selected row.

9. Click OKOK.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/create-product-master.md
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10. Click SaveSave.

11. Close the page.
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Create a product master

Add product dimensions

Generate product variants

This procedure walks through creating product variants for a product master using the combinations of product

dimensions. The demo company used to create this procedure is USMF.

1. Go to Product information management > Products > Product masters.

2. Click New.

3. In the Product number field, type a value.

4. In the Product name field, type a value.

5. In the Product dimension group field, enter or select a value.

6. Click OK.

Entering a product number manually is only required if no number sequence has been set for the

product number field. In other words, skip the step if number sequence has been set for the field.

Select the product dimension group SizeCol (Size and Color).

1. Click Product dimensions.

2. Click New.

3. In the list, mark the selected row.

4. In the Size field, enter or select a value.

5. In the Name field, type a value.

6. Click New.

7. In the list, mark the selected row.

8. In the Size field, enter or select a value.

9. In the Name field, type a value.

10. Click the Colors tab.

11. Click New.

12. In the list, mark the selected row.

13. In the Color field, enter or select a value.

14. In the Name field, type a value.

15. Click New.

16. In the list, mark the selected row.

17. In the Color field, enter or select a value.

18. In the Name field, type a value.

19. Click Save.

20. Close the page.

This example shows how to manually enter product dimensions. You can also choose to select a size,

color or style group that includes the product dimension values you want to use.

1. Click Product variants.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/create-predefined-product-variants.md
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2. Click Variant suggestions.

3. Click Select all.

4. Click Create.

5. Click Save.

In this example, all possible variants are selected. If only a subset of the possible product dimension

combinations will be used to create variants, you can select the individual entries.

You can generate descriptions for all your variants based on the combination of product dimension

values. The descriptions are optional.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Unit of measure conversion per product variant
2/18/2021 • 3 minutes to read • Edit Online

Turn on the feature in your system

Set up a product for unit conversion per variant

This topic explains how to set up unit of measure conversions for various product variants.

Instead of creating multiple individual products that must be maintained, you can use product variants to create

variations of a single product. For example, a product variant might be a T-shirt of a given size and color.

Previously, unit conversions could be set up only on the product master. Therefore, all product variants had the

same unit conversion rules. However, when the Unit of measure conversions for product variants feature is

turned on, if your T-shirts are sold in boxes, and the number of T-shirts that can be packed in a box depends on

the size of the T-shirts, you can now set up unit conversions between the different shirt sizes and the boxes that

are used for packaging.

If you don't already see this feature in your system, go to Feature management, and turn on the Unit of measure

conversions for product variants feature.

Product variants can be created only for products that are product masters. For more information, see Create a

product master. The Unit of measure conversions for product variants feature isn't available for products that

are set up for catch-weight processes.

To configure a product master to support unit conversion per variant, follow these steps.

1. Go to Product information management > Products > Product mastersProduct information management > Products > Product masters .

2. Create or open a product master to go to its Product detailsProduct details  page.

3. Set the Enable unit of measure conversionsEnable unit of measure conversions  option to Yes.

4. On the Action Pane, on the ProductProduct tab, in the Set upSet up group, select Unit conversionsUnit conversions .

5. The Unit conversionsUnit conversions  page opens. Select one of the following tabs:

Intra-class conversionsIntra-class conversions  – Select this tab to convert between units that belong to the same unit

class.

Inter-class conversionsInter-class conversions  – Select this tab to convert between units that belong to different unit

classes.

6. Select NewNew  to add a new unit conversion.

7. Set the Create conversion forCreate conversion for  field to one of the following values:

ProductProduct – If you select this value, you can set up a unit conversion for the product master. That unit

conversion will be used as a fallback for all product variants that no unit conversion is defined for.

Product var iantProduct var iant – If you select this value, you can set up a unit conversion for a specific product

variant. Use the Product var iantProduct var iant field to select the variant.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/uom-conversion-per-product-variant.md


TIPTIP

Example scenario

8. Use the other fields that are provided to set up your unit conversion.

9. Select OKOK to save the new unit conversion.

You can open the Unit conversionsUnit conversions page for a product or a product variant from any of the following pages:

Product details

Released products details

Released product variants

In this scenario, a company sells T-shirts in sizes small, medium, large, and extra-large. The T-shirt is defined as

a product, and the different sizes are defined as variants of that product. The shirts are packed in boxes. For sizes

small, medium, and large, there can be five shirts in each box. However, for size extra-large, there is space for

only four shirts in each box.

The company wants to track the different variants in the Pieces unit, but it's selling them in the Boxes unit. For

sizes small, medium, and large, the conversion between the inventory unit and the sales unit is 1 Box = 5 Pieces.

For size extra-large, the conversion is 1 Box = 4 Pieces.

F IEL DF IEL D SET T IN GSET T IN G

Create conversion for Product variant

Product variant T-Shirt : : X-Large : :

From unit Boxes

Factor 4

1. From the Released product detailsReleased product details  page for the T-Shir tT-Shir t product, open the Unit conversionsUnit conversions  page.

2. On the Unit conversionsUnit conversions  page, set up the following unit conversion for the X-LargeX-Large released product

variant.



Using Excel to update the unit conversions

Additional resources

NOTENOTE

To Unit Pieces

F IEL DF IEL D SET T IN GSET T IN G

F IEL DF IEL D SET T IN GSET T IN G

Create conversion for Product

Product T-Shirt

From unit Boxes

Factor 5

To Unit Pieces

3. Because the SmallSmall , MediumMedium, and LargeLarge product variants all have the same unit conversion between the

Box and Pieces units, you can define the following unit conversion for them on the product master.

If a product has many product variants that have different unit conversions, it's a good idea to export the unit

conversions to a Microsoft Excel workbook, update them, and then publish them back to Dynamics 365 Supply

Chain Management.

To export unit conversions to Excel, on the Unit conversionsUnit conversions  page, on the Action Pane, select Open inOpen in

Microsoft OfficeMicrosoft Office.

Manage unit of measure

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a released product

This procedure walks through how to create a single released product in the context of a single legal unit. After

the released product is created, it's immediately available in this unit only. You can walk through this procedure

in demo data company USMF. This task is usually performed by a product designer.

1. Go to Released products.

2. Click New.

3. In the Product number field, type a value.

4. In the Product name field, type a value.

5. In the Item model group field, click the drop-down button to open the lookup.

6. In the list, find and select the desired record.

7. In the list, click the link in the selected row.

8. In the Item group field, click the drop-down button to open the lookup.

9. In the list, find and select the desired record.

10. In the list, click the link in the selected row.

11. In the Storage dimension group field, click the drop-down button to open the lookup.

12. In the list, find and select the desired record.

13. In the list, click the link in the selected row.

14. In the Tracking dimension group field, click the drop-down button to open the lookup.

15. In the list, find and select the desired record.

16. In the list, click the link in the selected row.

17. In the Inventory unit field, click the drop-down button to open the lookup.

18. In the list, find and select the desired record.

19. In the list, click the link in the selected row.

20. In the Purchase unit field, click the drop-down button to open the lookup.

If a product number is not automatically entered in the Product number field, type a unique product

number. This step is only required if no number sequence has been set up for product numbers.

The Product name is defaulted to the search name. If needed, you can select to change the search

name.

The item model groups contain settings that determine how items are controlled and handled on item

receipts and issues. The settings also determine how the consumption of items are calculated.

Item groups are used to manage inventory by dividing inventory items into groups based on item

characteristics. For example, to manage how information is posted to main accounts, you can create a

series of different item groups that are associated with specific main accounts. This lets you track the

inventory value of items at different stages.

The storage dimensions help you control how items are stored and taken from inventory. For

example, a storage dimension can be Site and Warehouse.

The tracking dimension group determines which tracking dimensions you can add to a product. For

example, the batch number and serial number are used to track inventory items.

The inventory unit determines how the product is quantified when it's stored in inventory.

The purchase unit determines how the product is quantified when it's purchased from a vendor.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/create-released-product-single-company.md


Add product characteristics

Add financial dimensions

21. In the list, find and select the desired record.

22. In the list, click the link in the selected row.

23. In the Sales unit field, click the drop-down button to open the lookup.

24. In the list, find and select the desired record.

25. In the list, click the link in the selected row.

26. In the BOM unit field, click the drop-down button to open the lookup.

27. In the list, find and select the desired record.

28. In the list, click the link in the selected row.

29. In the Item sales tax group field, click the drop-down button to open the lookup.

30. In the list, find and select the desired record.

31. In the list, click the link in the selected row.

32. In the Item sales tax group field, click the drop-down button to open the lookup.

33. In the list, find and select the desired record.

34. In the list, click the link in the selected row.

35. Click OK.

The sales unit determines how the product is quantified when it's sold to a customer.

The BOM unit determines how the product is quantified when including it in a bill of materials (BOM).

The item sales tax group in the Sales taxation group determines how sales tax is calculated for each

item.

The item sales tax group in the Purchase taxation group determines how purchase tax is calculated for

each item.

1. Expand or collapse the Manage inventory section.

2. In the Net weight field, enter a number.

3. In the Tare weight field, enter a number.

4. In the Gross depth field, enter a number.

5. In the Gross width field, enter a number.

6. In the Gross height field, enter a number.

7. In the Volume field, enter a number.

1. Expand or collapse the Financial dimensions section.

2. In the BusinessUnit field, click the drop-down button to open the lookup.

3. In the list, find and select the desired record.

4. In the list, click the link in the selected row.

5. In the CostCenter field, click the drop-down button to open the lookup.

6. In the list, find and select the desired record.

7. In the list, click the link in the selected row.

8. In the Department field, click the drop-down button to open the lookup.

9. In the list, find and select the desired record.

10. In the list, click the link in the selected row.

11. In the ItemGroup field, click the drop-down button to open the lookup.

12. In the list, find and select the desired record.

13. In the list, click the link in the selected row.
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Products V2 EcoResProductV2Entity This entity is used to import and
export shared products-distinct
products and product masters. It
allows for updates. It doesn't support
set-based SQL operations. It's enabled
for Open Data Protocol (OData).

Released products V2 EcoResReleasedProductV2Entity This entity is used to import and
export released products-distinct
products and product masters. It
allows for updates. It requires that the
shared product already be created.
When a new released product is
imported, a release of the shared
product occurs. There are also separate
entities that can be used to import
and export released product masters
and released distinct variants. This
entity doesn't support set-based SQL
operations or delete operations. It's
enabled for OData.

Released product creation V2 EcoResReleasedProductCreationV2Entity This entity is used to import shared
products and released products in one
step. Although it supports exports,
that use isn't recommended, because
the purpose of the entity is product
creation. It doesn't support updates. It
supports a limited set of fields (fields
that are available in the product
creation dialog box). It doesn't support
set-based SQL operations. It isn't
exposed through OData.

Product variants EcoResProductVariantEntity This entity is used to import and
export shared product variants. It
allows for updates. It requires that
dimension values already be created.
The integration key is the product
master plus product dimensions. This
entity doesn't support set-based SQL
operations. It's enabled for OData. It
supports delete operations. It can't be
extended through the addition of new
product dimensions.

To import and export product data, you must use data entities. The following table provides details about the

product-related data entities and describes the purpose of each.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/data-entities.md


Product variants by product number
identification

EcoResProductNumberIdentifiedProductVariantEntityThis entity is used to import and
export shared product variants. It
allows for updates. It requires that
dimension values already be created.
The integration key is the product
number (whereas the integration key
for the Product variantsProduct variants  entity is the
product master plus product
dimensions).

Released product variants EcoResReleasedProductVariantEntity This entity is used to import and
export released product variants. It
allows for updates. It requires that
shared product variants already be
created. When a new released product
variant is imported, a release of the
shared product variant occurs. This
entity doesn't support set-based SQL
operations. It's enabled for OData.
Although it supports delete
operations, that use currently causes
data corruption because of a bug in
the current platform. This entity can't
be extended through the addition of
new product dimensions.

Released product variants by product
number identification

EcoResProductNumberIdentifiedReleasedProductVariantEntityThis entity resembles the ReleasedReleased
product variantsproduct variants  entity, but the
integration key is the product number
instead of the product master plus
product dimensions. It can be
extended through the addition of new
product dimensions.

Sellable released products EcoResSellableReleasedProductEntity This entity is used to export only
sellable products. Sellable products are
products that have the information
that they require in order to be used in
a sales order. The same rules apply
when a product is validated by using
the ValidateValidate function on the
Released productsReleased products  page.

Released Distinct products V2 EcoResDistinctProductV2Entity This entity is used to export distinct
products. Those distinct products can
be products, subtype products, and
product variants.

Released products masters V2 EcoResProductMasterV2Entity This entity is used to import and
export product masters. It isn't
enabled for data management.

Item - barcode EcoResProductBarcodeEntityV3 This entity is used to export products
and bar codes. This entity doesn't allow
change tracking, updates, or deletes.
To use change tracking, updates, or
deletes on barcodes, use the Item -Item -
barcode associationbarcode association entity.
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Item - barcode association EcoResProductBarcodeAssociationEntity This entity is used to export products
and bar codes. It allows change
tracking, updates, and deletes. To use
the entity, the feature Item - barcode
improvements must be enabled in
feature management. Its entity key is 
AssociationID , which creates the

association between the barcode and
the product. To add support for this
key, the table 
InventitemBarcodeAssociation  will

be populated for existing item barcode
data when you turn on the feature.
The table is populated using a batch
job and if your barcode table has a
large number of records, it could take
significant time to run the batch job.
Therefore, we recommend that you
plan to enable the feature (and
therefore run the batch job) at a time
that fits your business schedule.

Product lifecycle states EcoResProductLifecycleSateEntity This entity is used to import and
export the different product lifecycle
states that can be assigned to a
product.
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NOTENOTE

NOTENOTE

You can use the Released Products V2Released Products V2  data entity to import products into the system only if the shared product has

already been created. Otherwise, to import products into the system, you must use the Product creationProduct creation data entity.
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The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a new product lifecycle state

Associate product lifecycle states to released products

Impact on master planning

A product lifecycle state documents the lifecycle state of a released product or product variant. Product lifecycle

states are defined by the user, typically a product manager or a product master data manager. Specific business

processes, such as master planning, can be affected by a specific lifecycle state.

A released product or product variant can be associated with a product lifecycle state that documents in which

lifecycle state a specific product or variant is currently in. You can define any number of product lifecycle states

by assigning a state name and description. You can select one lifecycle state as the default state for new released

products. Released product variants inherit their product lifecycle state from their released product master on

creation. When changing the lifecycle state on a released product master, you can choose to update all existing

variants that have the same original state.

To create a new product lifecycle state, see Create a new product lifecycle state.

To create a default product lifecycle state, see Create a default product lifecycle state.

There are multiple ways to associate a product lifecycle state to released products or product variants.

On creation of a new released product, the default Product lifecycle stateProduct lifecycle state is automatically assigned.

On release of a product to a legal entity, the default Product lifecycle stateProduct lifecycle state is automatically assigned.

On release of a product variant to a legal entity, the Product lifecycle stateProduct lifecycle state associated to the released

product master in this legal entity is automatically assigned to the new variant.

You can manually update the product lifecycle state by using:

The Released productsReleased products  list page or Details viewDetails view .

The Released product var iantsReleased product var iants  list page or Details viewDetails view .

Find the obsolete products or product variants based on demand and associate a lifecycle state.

For more information:

To associate a product lifecycle state to a released product master, see Assign a product lifecycle state to a

released product master.

To associate a product lifecycle state to a release product, see Assign a product lifecycle state to a released

product.

The product lifecycle state has only one control flag: Is active for planningIs active for planning. By default, this is set to YesYes  for all

created product lifecycle states, but it can be changed to NoNo. When set to NoNo, the associated released products

or released product variants are:

Excluded from master planning.

Excluded from BOM-level calculation.

For detailed information about how to use product lifecycle state to exclude products from master planning and

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/product-lifecycle.md
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Default migration, import, and export

Find obsolete products and products variants

NOTENOTE

Criteria to select and update released products or product variants

BOM-level calculation, see Create a product lifecycle state to exclude products from Master planning

For performance reasons, it is highly recommended to associate all obsolete released products or product variants,

especially when working with non-reusable product configuration variants, with a product lifecycle state that is

deactivated for master planning.

The product lifecycle states are supported by data entities, and the lifecycle state can be set to a variable state

through either the released product data entity or the released variant data entity.

You can run a simulation analysis to find the obsolete released products or product variants and then update

their product lifecycle status. To find obsolete products, see Find obsolete product variants and assign a product

lifecycle state. This topic shows how to find obsolete released products or product variants and how to associate

a product lifecycle state to the obsolete products. It also shows hot to view the simulation results and assess

how many products and product variants will be associated with a new product lifecycle state when running the

update without simulation.

By running the analysis in a simulation mode, the products and product variants identified as obsolete are

displayed in a specific form, where they can easily be reviewed. The analysis searches for transactions and

specific master data to identify products that have no demand within a variable period and no master data that

can result in demand. New released products within a variable period can be excluded from the analysis. When

the analysis simulation returns the expected result, the user can run the analysis and set a new product lifecycle

state to all products identified as obsolete by the analysis.

Note that all analysis and updates must be done within the same legal entity.

Use the following criteria to select and update the released products and product variants:

The product lifecycle state of the product or product variant must be different from the new desired state.

The product or product variant was created some days ago based on the number of days that you enter in

the selection dialog box.

There are no open production orders (= status < ended) for the product or product variant.

There are no open inventory transactions (= status issue ReservPhysical to QuotationIssue or status receipt

Registrered to QuotationReceipt) for the product or product variant.

There are no inventory transactions within the last number of days for the product or product variant.

There is no future demand or supply forecast for the product or product variant.

No minimum stock level has been set in item coverage for the product or product variant.

No active fixed quantity kanban rule for the product or product variant.

No service order line for the product or product variant.

No active or future sales or purchase agreement lines for the product or product variant.

The product or product variant is not used in a BOM that is associated with a non-expired approved BOM

version for a product or variant that is active for planning.



Related topics
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Create a new product lifecycle state

Create a default product lifecycle state

Assign a product lifecycle state to a released product master

Assign a product lifecycle state to a released product

Find obsolete product variants and assign a product lifecycle state

Create a product lifecycle state to exclude products from Master planning
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Create a product lifecycle state

NOTENOTE

This procedure shows how to create a new product lifecycle state. A product lifecycle state documents the

lifecycle state of a released product or product variant. Product lifecycle states are defined by the user, typically a

product manager, or a product master data manager. Specific business processes, for example, Master planning,

can be affected by a specific lifecycle state.

1. Go to Product information management > Setup > Product lifecycle state.

2. Click New.

3. In the State field, type a value.

4. In the Description field, type a value.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/new-product-lifecycle-state.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a default product lifecycle state
2/18/2021 • 2 minutes to read • Edit Online

Create a default lifecycle state

NOTENOTE

Create a new released product

NOTENOTE

Change the product to an active state

This procedure shows how to create a default product lifecycle state as well as how to associate the default state

with released products.

1. Go to Product information management > Setup > Product lifecycle state.

2. Click New.

3. In the State field, type a value.

4. Select Yes in the Default when released to legal entity field.

5. In the Description field, type a value.

6. Select No in the Is active for planning field.

If a new released product should not be included in Master planning, select No. If it should be included in Master

planning, leave the control at its default value Yes.

1. Close the page.

2. Go to Product information management > Products > Released products.

3. Click New.

4. In the Product number field, type a value.

5. In the Product name field, type a value.

6. In the Search name field, type a value.

7. In the Item model group field, enter or select a value.

8. In the Item group field, enter or select a value.

9. In the Storage dimension group field, enter or select a value.

10. In the Tracking dimension group field, enter or select a value.

11. Click OK.

The default product lifecycle state is a global definition.

1. In the Product lifecycle state field, enter or select a value.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/default-product-lifecycle-state.md
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Assume that you have set up an active state, you can now select the active state to allow the product to be used in

Master planning and BOM-level calculation. Obviously, this only makes sense if all the product details that are required

for consistent planning are specified.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Find a released product master

NOTENOTE

Update the lifecycle state

NOTENOTE

Verify the lifecycle state of the variants

NOTENOTE

NOTENOTE

This procedure shows how to assign a product lifecycle state to a released product master and its variants.

Prerequisite: You need to play the task guide "Create a new product lifecycle state" first to make sure that you

have at least one product lifecycle state created before you can play this task guide.

1. Go to Product information management > Products > Released products.

2. In the list, find and select the desired record.

A product master has the Product subtype Product master.

1. Click Edit.

2. In the Product lifecycle state field, enter or select a value.

3. Click Save.

4. Click Yes.

If Yes is selected, all the related released product variants that have the same original status as the released product

master are also updated to the new product lifecycle state. If No is selected, all variants keep their actual state. Variants

that have a different product lifecycle state from the released product master are not updated.

1. Click Released product variants.

Note that all variants have inherited the selected lifecycle state from the released product master.

2. In the list, mark the selected row.

3. In the Product lifecycle state field, enter or select a value.

Can you tell us about your documentation language preferences? Take a short survey.
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Find a released product that you want to assign a product lifcycle
state

NOTENOTE

This procedure shows how to assign a product lifecycle state to a released product. Prerequisite: You need to

play the task guide "Create a new product lifecycle state" first to make sure that at least one product lifecycle

state is created before you can play this guide.

1. Go to Product information management > Products > Released products.

2. Use the Quick Filter to find records. For example, filter on the Item number field with a value of 'd'.

3. In the list, click the link in the selected row.

4. Click Edit.

5. In the Product lifecycle state field, enter or select a value.

6. Click Save.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Run a simulation

NOTENOTE

Review the simulation results

NOTENOTE

Run the update of the Product lifecycle state for obsolete products

NOTENOTE

This procedure shows how to find obsolete released products or product variants and how to associate a

product lifecycle state to the obsolete products. Prerequisite: You need to define at least one product lifecycle

state that is inactive for planning before you can play this task guide.

1. Go to Product information management > Periodic tasks > Change lifecycle state for obsolete products.

2. In the New product lifecycle state field, enter or select a value.

3. Select Yes in the Run simulation without updating product data field.

4. In the Exclude products created within this number of days field, enter a number.

5. In the Exclude products used in transactions (in number of days) field, enter a number.

6. Expand the Records to include section.

7. Click Filter.

8. In the list, mark the selected row.

9. In the Criteria field, type a value.

10. Click OK.

11. Click OK.

It is recommended to run the simulation in batch if you expect to search a large number of products. Also, make sure that

the simulation is not run during the most active working time of the company.

1. Go to Product information management > Inquiries and reports > Product lifecycle state maintenance

history.

On this page, you can review the simulation results and make an assessment of how many products and product variants

will be associated with a new product lifecycle state when running the update without simulation.

1. Close the page.

2. Go to Product information management > Periodic tasks > Change lifecycle state for obsolete products.

3. Expand the Records to include section.

Note that the last selection has been saved.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/obsolete-product-variants.md
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4. Select No in the Run simulation without updating product data field.

5. Expand the Run in the background section.

Depending on how many products and product variants are affected, consider running this job in batch. Make sure that

you are not running a large update job during the most active working hours in the company.

6. Click OK.

7. Go to Product information management > Inquiries and reports > Product lifecycle state maintenance

history.

Review the changed released products and product variants.

8. In the list, find and select the desired record.

Can you tell us about your documentation language preferences? Take a short survey.
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Create an obsolete state

Associate the obsolete state to a released product

NOTENOTE

This procedure shows how to create a new product lifecycle state that excludes the products from Master

planning and BOM-level calculation.

1. Go to Product information management > Setup > Product lifecycle state.

2. Click New.

3. In the State field, type a value.

4. Select No in the Is active for planning field.

5. In the Description field, type a value.

1. Close the page.

2. Go to Product information management > Products > Released products.

3. Use the Quick Filter to find records. For example, filter on the Search name field with a value of 'M00'.

4. Click Edit.

5. In the list, mark the selected row.

6. In the Product lifecycle state field, enter or select a value.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a bar code for a product
2/18/2021 • 2 minutes to read • Edit Online

NOTENOTE

This topic shows how to manually create a bar code using the item number M0001 as an example. The demo

data company used to create this procedure is USMF.

1. Select Released product maintenanceReleased product maintenance on the homepage.

2. Go to Products > Released productsProducts > Released products  under the L inksLinks  section.

3. In the list, find and select the desired record. For this example, select item number M0001M0001 .

4. On the Action Pane, select Manage inventor yManage inventor y .

5. Select Bar codesBar codes .

6. Select NewNew .

7. Mark the selected row that is created in the list below.

8. In the Barcode setupBarcode setup field, enter or select a value.

9. In the Bar codeBar code field, enter or select a value.

10. In the Bar codeBar code field, type a value.

11. In the QuantityQuantity  field, enter a number.

12. Select SaveSave.

13. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.
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Enter the GTIN code for a product
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NOTENOTE

GTIN codes are assigned by the GS1 organization. In this example, you will enter a code for product number

M0001 in demo data company USMF.

1. Click Released product maintenance.

2. Click Released products.

3. Expand the Product image FactBox.

4. In the list, find and select the desired record.

5. On the Action Pane, click Manage inventory.

6. Click GTIN codes.

7. Click New.

8. In the list, mark the selected row.

9. In the Unit field, enter or select a value.

10. In the GTIN code field, select an option.

11. In the GTIN field, type a value.

12. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create batch attributes for a product
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NOTENOTE

This procedure shows how to create a batch attribute, assign default value ranges, and include the attribute in a

group. The demo data company used to create this procedure is the USP2 Company.

1. Go to Inventory management > Setup > Batch > Batch attributes.

2. Click New.

3. In the Attribute field, type a value.

4. In the Description field, type a value.

5. In the Attribute type field, select 'Fraction'.

6. In the Minimum field, enter a number.

7. In the Maximum field, enter a number.

8. In the Increment field, enter a number.

9. In the Target field, type a value.

10. Click Save.

11. Close the page.

12. Go to Inventory management > Setup > Batch > Batch attribute groups.

13. Click New.

14. In the Attribute group field, type a value.

15. In the Description field, type a value.

16. Click Save.

17. Click Group attributes.

18. Click New.

19. In the Attribute field, click the drop-down button to open the lookup.

20. In the list, find and select the desired record.

21. In the list, click the link in the selected row.

22. Click Save.

23. Close the page.

This procedure uses the Fraction type to enable decimal values. You can select other attribute types. If

you select the Enumeration type, you must enter values in the enumeration list before you can enter a

value in the Target field.

An attribute can be included in any of the groups.

Can you tell us about your documentation language preferences? Take a short survey.
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Add an image to a product
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NOTENOTE

This procedure shows how to add an image to a product The demo data company used to create this task is

USMF.

1. Go to Product information management > Products > Released products.

2. Expand the Product image FactBox.

3. In the list, find and select the desired record.

4. Click Change image.

5. Click New.

For example, select the item number C0002.

Click Browse. Find the image that you want to use, select it, and then close the dialog box.

Can you tell us about your documentation language preferences? Take a short survey.
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Country of origin
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IMPORTANTIMPORTANT

Turn on the country of origin feature

Configure source and destination countries

Keep track of vendor certificates

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

Many organizations issue certificates to their vendors to ensure that products meet specific certification

standards. These certificates often depend on the country of origin. The country of origin feature lets you link a

product to its country of origin and keep track of its product certifications.

Before you can use this feature, it must be turned on in your system. Admins can use the feature management

settings to check the status of the feature and turn it on. In the Feature managementFeature management workspace, the feature is

listed in the following way:

Module:Module: Product information management

Feature name:Feature name: Country of origin management feature

Before you issue a certificate for a product, you must link the product to its destination country and its country

of origin.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Item number Select the item number of the product.

Destination country Select the country that you're sending the product to.

Origin country Select the country that you're shipping the product from.

1. Go to Product information management > Setup > Product compliance > Countr y of or igin >Product information management > Setup > Product compliance > Countr y of or igin >

Countr y of or igin rulesCountr y of or igin rules .

2. Select an existing country setup to edit, or select NewNew  on the Action Pane to create a new country setup.

3. Set the following values for the selected or new country.

The purpose of this setup is to help you generate a bill of materials (BOM) report where you can include the

country of origin for each part that source and destination countries are specified for. This report will help you

get a holistic picture of where your parts come from and where they are going.

You can use the Countr y of or igin vendor cer tificatesCountr y of or igin vendor cer tificates  page to keep track of certificates that you issue to

vendors.

You must decide which certificate documents you're issuing and how you will report them to customers. This

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/country-of-origin.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version


Include the country of origin on BOM reports

feature helps you keep track of your certificates. It also lets you choose whether the relevant certificate numbers

appear on invoices, packing slips, and/or order confirmations.

To set up your certificate information, follow these steps.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Vendor account Select the vendor that you issued the certificate to.

Item number Select the item that you issued the certificate for.

Country/region The destination country or region where you must use
this certificate.

Certificate number Enter the identification number of the certificate that you
issued.

Effective Select the first date when the current certificate is valid.

Expiration Select the last date when the current certificate is valid.

Print on invoice Select this check box to print the certificate number on
invoices that are addressed to the specified country
during the specified date range.

Print on packing slip Select this check box to print the certificate number on
packing slips that are addressed to the specified country
during the specified date range.

Print on sales order Select this check box to print the certificate number on
sales orders that are addressed to the specified country
during the specified date range.

1. Go to Product information management > Setup > Product compliance > Countr y of or igin >Product information management > Setup > Product compliance > Countr y of or igin >

Countr y of or igin vendor cer tificatesCountr y of or igin vendor cer tificates .

2. Select an existing certificate setup to edit, or select NewNew  on the Action Pane to create a new certificate

setup.

3. Set the following settings for the selected or new certificate.

When you generate a BOM report, you can include the country of origin for each part that you specified source

and destination countries for on the Countr y of or igin rulesCountr y of or igin rules  page.

1. Go to Product information management > Products > Released productsProduct information management > Products > Released products .

2. Select or create a product to open its Released product detailsReleased product details  page.

3. On the Action Pane, on the EngineerEngineer  tab, in the BOMBOM group, select DesignerDesigner .

4. On the page that appears, on the Action Pane, select BOM > PrintBOM > Print.

5. In Bill of mater ials linesBill of mater ials lines  dialog box, set the Destination countr yDestination countr y  field to the destination country that you

want to view on your report.

6. Select OKOK.

A report that shows information about the country of origin of each part is generated and shown. Here is an

example of the report.



NOTENOTE
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Dual-use goods
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Define dual-use requirements for each relevant country

Dual-use goods are typically items that have both civilian and military applications. For example, a chemical

might be used as either a fertilizer or an explosive. Many countries have special regulations that apply to the

export, import, and transportation of dual-use goods. Therefore, it's important that companies that are involved

in the international trade of dual-use goods keep track of the various policies and certificates.

The dual-use feature helps companies keep track of products that are identified as dual-use goods, stores

certificate numbers for each relevant product and destination country, and print valid certificate numbers on

relevant invoices, packing slips, and/or sales orders. It helps ensure that, when your products are shipped, they

always include up-to-date certifications.

Consider the following scenario:

1. The Dual use countr y setupDual use countr y setup page in your system indicates that shipments to France require a

certification.

2. The Released product detailsReleased product details  page for product X-100 indicates that it's a dual-use good. Together, the

code, category, group, and regime indicate the export control classification that the product belongs to.

3. The Dual use cer tificatesDual use cer tificates  page includes a certificate for product X-100 when it's shipped to France. This

certificate expires January 1, 2020.

4. On June 17, 2020, you create a sales order for a customer company that is based in France, and the order

includes product X-100.

5. When you save the sales order, the system determines the following information:

a. Does the order include any products that are dual-use goods?

b. If the order includes dual-use goods, does the destination country require dual-use certificates?

c. If the country requires dual-use certificates, does a valid certificate exist for each dual-use good for

the destination country?

6. The order includes product X-100, the product is being shipped to France, and a French certificate exists

for the product. However, the certificate has expired. Therefore, you receive the following warning

message: "Dual use certificates for one or more dual-use items in this sales order aren't valid. Do you

want to proceed with the confirmation?"

This topic explains how to configure all the settings that are required to set up dual-use goods and support this

scenario.

Different countries have different requirements for dual-use goods. You use the Dual use countr y setupDual use countr y setup page

to keep track of the countries that do and don't require a certificate. The information that you specify here is

checked when you create sales orders, and you will be reminded to provide the required certifications.

To set up the information about dual-use requirements for different countries, follow these steps.

1. Go to Product information management > Setup > Product compliance > Dual use productsProduct information management > Setup > Product compliance > Dual use products

> Dual use countr y setup> Dual use countr y setup.

2. Select an existing country setup to edit it, or select NewNew  on the Action Pane to create a new country

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/dual-use.md


Create dual-use categories

Apply dual-use categories to products

Set up dual-use certificates

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Country/region Select the country that you're tracking requirements for.

Certificate Required Select this check box for countries that require a
certification for dual-use goods. Clear it for countries
that don't require this certification.

setup.

3. Set the following values for the selected or new country setup.

Dual-use goods must often be categorized according to their export control classification number (ECCN). The

ECCN is an alphanumeric code that categorizes items based on factors such as the commodity and technology.

The Dual use categoriesDual use categories  page helps you make a list of the categories that you use, for reporting purposes.

To set up dual-use categories, follow these steps.

F IEL DSF IEL DS DESC RIP T IO NDESC RIP T IO N

Dual use code Enter the full ECCN code (for example, 3A001).

Dual use category Enter the commerce control list (CCL) category part of
the ECCN code. For example, for the ECCN code 3A001,
this value is 3.

Dual use group Enter the product group part of the ECCN code. For
example, for the ECCN code 3A001, this value is A.

Dual use regime Enter the regime code for the item. This code identifies
the reason why the item is classified as a dual-use good.
For example, for the ECCN code 3A001, this value is 001.

1. Go to Product information management > Setup > Product compliance > Dual use productsProduct information management > Setup > Product compliance > Dual use products

> Dual use categories> Dual use categories .

2. Select an existing category to edit it, or select NewNew  on the Action Pane to create a new category.

3. Set the following values for the selected or new category.

To identify a product as a dual-use good and apply a dual-use category to it, follow these steps.

1. Go to Product information management > Products > Released productsProduct information management > Products > Released products .

2. Select or create a product to open its Released product detailsReleased product details  page.

3. On the Foreign tradeForeign trade FastTab, set the Dual use productsDual use products  option to YesYes  to identify the current product as a

dual-use good.

4. Set the Dual use codeDual use code field to the code that applies to the current product. (You defined this code on the

Dual use categoriesDual use categories  page.)

This setup is checked when you create a sales order.



NOTENOTE

You use the Dual use cer tificatesDual use cer tificates  page to set up and manage the required dual-use certificates for each

product and country. You can track each certificate's details, such as the country and the dates of validity. You can

also set options to specify where this information should be printed. For example, the information can be

printed on the invoice, packing slip, and/or sales order. This setup is checked when you create a sales order.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Item number Select the item number of the dual-use good that this
certificate applies to.

Country/region The destination country or region where you must use
this certificate.

Certificate number The number that appears on the certificate that is issued
to the vendor or customer.

Effective Select the first date when the current certificate is valid.

Expiration Select the last date when the current certificate is valid.

Print on invoice Select this check box to print the certificate number on
invoices that are addressed to the specified country
during the specified date range.

Print on packing slip Select this check box to print the certificate number on
packing slips that are addressed to the specified country
during the specified date range.

Print on sales order Select this check box to print the certificate number on
sales orders that are addressed to the specified country
during the specified date range.

1. Go to Product information management > Setup > Product compliance > Dual use productsProduct information management > Setup > Product compliance > Dual use products

> Dual use cer tificates> Dual use cer tificates .

2. Select an existing certificate to edit it, or select NewNew  on the Action Pane to create a new certificate.

3. Set the following values for the selected or new certificate.
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Hazardous materials overview
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IMPORTANTIMPORTANT

IMPORTANTIMPORTANT

Product information management

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

To remain compliant with shipping and transport regulations, organizations that ship materials that are

classified as dangerous goods must include additional paperwork with their shipments. The hazardous materials

feature lets customers store information that is related to released items. This information can then be used to

help prepare shipping documentation. An organization that ships dangerous goods must have its own

processes and procedures for managing the shipping process. Microsoft Dynamics 365 Supply Chain

Management is just a tool that can help generate the required documents.

The following diagram illustrates the steps needed to set up and use the hazardous materials feature.

The hazardous materials feature is set up in Product information management and provides documents that can

be printed through Warehouse management. Therefore, broadly speaking, those areas are the two main areas

where you will review, set up, and use this feature's functionality:

Product information managementProduct information management – Set up the codes that will be applied to a released product.

Warehouse managementWarehouse management – Work with additional shipping documents that will be printed for shipments.

The hazardous materials features in Supply Chain Management provide a collection of useful product information fields

and related functionality that can help you record and reference information that is related to your hazardous products.

These features can also help you design and print shipment documents that include some of the same information about

any hazardous materials that you're shipping. However, the system won't automatically make you compliant with all

applicable regulations in your country or region. Although these tools are intended to help you comply with common

regulations, they are neither sufficient in themselves nor guaranteed to be so. Your organization is responsible for being

aware of all applicable regulations and for taking all necessary steps to comply with them.

Product information management provides a range of setup tables where you can enter reference information

for the various dangerous goods lists for road, air, and sea freight.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/hazmat-overview.md
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Warehouse management

NOTENOTE

The following common regulations were referenced when this functionality was developed:

ADRADR  – Regulations that are related to the international carriage of dangerous goods by road

CFR 49CFR 49  – Regulations in the United Sates for the carriage of dangerous goods

IMDGIMDG – The International Marine Dangerous Goods (IMDG) code

IATAIATA – The International Air Transport Association (IATA) dangerous goods regulations

Each set of regulations provides standardized lists of dangerous goods and reference codes. Therefore, Supply

Chain Management provides a reference table for the common codes on those lists. Each list also has some

unique codes that you can define.

For more information about how to set up regulations and values for hazardous materials, and how to assign

the values to relevant products, see the following topics:

Set up hazardous materials

Hazardous materials in products, orders, shipments, and loads

When you prepare a shipment in Warehouse management, you will be able to print several new reports that use

the information that you set up in Product information management. For more information about the available

reports and how to use them, see Hazardous materials inquiries and reports.
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IMPORTANTIMPORTANT

Turn on the hazardous materials feature for your system

Hazardous material regulations

IMPORTANTIMPORTANT

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

To use hazardous materials functionality, you must first set up the data that is required to classify items as

hazardous materials. Then, when you create a sales order that includes an item that is classified as a hazardous

material, the system generates hazardous material documentation for that sales order when it's shipped.

Before you can use this feature, it must be turned on in your system. Admins can use the feature management

settings to check the status of the feature and turn it on. In the Feature managementFeature management workspace, the feature is

listed in the following way:

Module:Module: Product information management

Feature name:Feature name: Hazardous materials product information and shipping documentation

To use the hazardous materials processes, you must first create a regulation. Regulations define how the printed

shipping text is created for an item. They also define the associated modes of delivery.

Here are some common regulations:

ADRADR  – Regulations that are related to the international carriage of dangerous goods by road

CFR 49CFR 49  – Regulations in the United Sates for the carriage of dangerous goods

IMDGIMDG – The International Marine Dangerous Goods (IMDG) code

IATAIATA – The International Air Transport Association (IATA) dangerous goods regulations

These regulations help determine what information should be shown when you print the shipping text for an

item. You can define as many regulations as you must comply with.

The functionality for setting up information codes that are related to hazardous materials doesn't make your company

compliant with regulations. It's only a tool that helps you build processes for your company.

Typically, a regulation is available for a specific mode of transport, such sea freight, road freight, or air freight.

Therefore, you can associate each regulation with a mode of delivery. The mode of delivery will be used when

specific documents are printed in Warehouse management. In Warehouse management, each shipment is linked

to a shipping carrier and carrier service that are set up in the Transpor tationTranspor tation module. The mode of delivery is

associated with the shipping carrier and carrier service. When you run a report, the mode of delivery is used to

find the shipping print text that is associated with a released item.

This setup data isn't specific to each legal entity (company). Therefore, you can have a common set of hazardous

material information that is shared among all your legal entities.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/hazmat-setup.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version


Hazardous material regulation headerHazardous material regulation header

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Regulation code Enter a code to identify the hazardous material regulation
record.

Description Enter a description of the hazardous material regulation.

Print setup FastTabPrint setup FastTab

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Sequence Define the order in which fields will be referenced in the
shipping text.

For each regulation, you can define a materials list and use it as a template list that is associated with released

items. For each regulation, you can also define a print setup. A print setup lets you define how the shipping text

for an item is constructed. The print setup is used to construct the shipping print text for a released item.

To set up hazardous material regulations, go to Product information management > Setup > HazardousProduct information management > Setup > Hazardous

mater ial shipping documentation > Hazardous mater ial regulationmater ial shipping documentation > Hazardous mater ial regulation. On the Hazardous mater ialHazardous mater ial

regulationregulation page, you can create any number of regulations and configure each by using the fields that are

described in the following subsections.

Each regulation has a code and a description. The following table describes the fields that are available on the

header.

Each regulation can have any number of print setups. You define the print setups on the Pr int setupPrint setup FastTab.

The following table describes the fields that are available for each print setup.



Print field Select the field to include in the shipping text. Not all fields
for the hazardous material will be available to print. Only the
common fields that are used to define shipping text in the
various regulations will be available. You should define the
first print field as a field separator that has a SequenceSequence
value of 0 (zero), so that it can be used as the separator
between other fields. Only one reference to the field
separator is required.

Print before Enter the text that should be printed before the content that
is defined by the Print fieldPrint field setting.

Print after Enter text that should be printed after the content that is
defined by the Print fieldPrint field setting.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

The following values are available:

Field separatorField separator  – This print field is used as the field
separator for the text. Only one field separator is
required in the sequence. Usually you should set the
SequenceSequence value for this print field to 0 (zero). The
system will look for a field separator and use the first
one that it finds in the list. The text value that is used
in the string will come from the Print afterPrint after  field.

IdentificationIdentification – This print field puts the identifying
code and/or description in the print text.

ClassClass  – This print field puts the class code and/or
description in the print text.

DivisionDivision – This print field puts the division code
and/or description in the print text.

Packing groupPacking group – This print field puts the packing
group code and/or description in the print text.

Tunnel code and/or descriptionTunnel code and/or description – This print field
puts the tunnel code and/or description in the print
text.

Proper shipping nameProper shipping name – This print field puts the
proper shipping name in the print text.

Technical nameTechnical name – This print field puts the technical
name and/or description in the print text.

Transpor t categor yTranspor t categor y  – This print field puts the
transport category code and/or description in the
print text.

StowageStowage – This print field puts the stowage code
and/or description in the print text.

Fixed textFixed text  – This print field enters the text that is
defined in the Fixed textFixed text  field for this row.

Label code and/or descriptionLabel code and/or description – This print field
puts the label code and/or description in the print
text.

Aircraft packingAircraft packing – This print field puts the aircraft
packing instructions code and/or description in the
print text.

Limited quantityLimited quantity  – This print field checks whether
the item is marked as a limited-quantity item and, if
it is, enters the text that is defined in the Fixed textFixed text
field for this row.

Packing descriptionPacking description – This print field puts the
packing description in the print text.



 

Print with previous Select this check box to prevent the field separator from
being printed between the previous field and this field. Use
this check box for print fields that are either optional or
included with another print field.

Fixed text If you set the Print fieldPrint field field to Fixed textFixed text  or LimitedLimited
quantityquantity , enter the text that should be printed.

Include in print Select which value or values from the selected print field
should be printed for this row. You can print the code, the
description, or both the code and the description.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Mode of delivery FastTabMode of delivery FastTab

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Company Select a legal entity to associate with this regulation.

Mode of delivery Based on the legal entity that you selected, select the mode
of delivery that should be associated with the regulation.

Country FastTabCountry FastTab

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Country/region Select a country/region to associate with the regulation.

Material codes

The regulation is a shared table and isn't specific to each legal entity. However, modes of delivery are legal

entity–specific. Therefore, when you set up a mode of delivery, you must select the relationship between the

regulation, legal entity, and mode of delivery.

The following table describes the fields that are available on the Mode of deliver yMode of deliver y  FastTab.

For reference purposes, you can list the countries or regions that the regulation is relevant for. However, when

shipment reports are run, only the mode of delivery is used to determine the regulation. When you review a

warehouse shipment, there isn't a direct link to the mode of delivery. The shipment can be associated with a

shipping carrier and carrier service. When you define a carrier service, you must associate it with a mode of

delivery. This relationship will be used on shipment reports such as the bill of lading to find the shipping print

text for an item.

The following table describes the field that is available on the Countr yCountr y  FastTab.

Material codes establish settings that are related to a specific hazardous component that might be included in a

released product. Each material code belongs to a specific hazardous material regulation, and its definition must

conform to that regulation. When you apply a material code to a released product by using the Mater ial codeMaterial code

field, all the material code's hazardous materials settings are automatically applied to that product. Therefore,

the process of setting up released products is faster and less prone to error.

To manage your hazardous material definitions, follow these steps.

1. Go to Product information management > Setup > Hazardous mater ial shippingProduct information management > Setup > Hazardous mater ial shipping

documentation > Hazardous mater ial regulationdocumentation > Hazardous mater ial regulation.



  

   

Hazardous material classification groups
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Group code Enter a code to identify the group.

Description Enter a description of the group.

Class code Associate a hazardous material class code with the group.

Division code Associate a hazardous material division code with the group.

Packing group code Associate a packing group code with the group.

Transport category code Associate a transport category code with the group.

Multiplier Enter the hazardous material multiplier that applies to the
selected class and division of hazardous materials, according
to the applicable regulation. This multiplier is used as part of
the formula that calculates the total hazardous material
points that are included in a load or shipment. For more
information about hazardous material points and this
multiplier, see Material management FastTab.

Hazardous material classes

2. Select the regulation to set up a hazardous material definition for.

3. On the Action Pane, on the SetupSetup tab, select Hazardous mater ialsHazardous mater ials .

4. In the Mater ial codeMaterial code field, enter a material code for the hazardous material definition. You will select this

value when you apply the material code to a released product.

The Regulation codeRegulation code field is read-only and shows the regulation that you selected in step 2.

5. Use the remaining fields on this page to create and set up each hazardous material that applies to your

selected regulation. The fields that are available are a subset of the hazardous material fields that are

available for individual released products. For more information, see Hazardous materials in products,

orders, shipments, and loads.

Each hazardous material classification group defines a group of field values that establish a template. You can

use this template later, when you set up hazardous material information for a released item.

When you assign the code for a hazardous material classification group to a released item, the information that

is associated with that classification group will be copied into the appropriate fields of the item. Therefore, you

can simplify the setup processes by establishing a set of related field values that you often use together.

This setup data isn't specific to each legal entity. Therefore, you can have a common set of hazardous material

information that is shared among all your legal entities.

To set up hazardous material classification groups, go to Product information management > Setup >Product information management > Setup >

Hazardous mater ial shipping documentation > Hazardous mater ial classification groupHazardous mater ial shipping documentation > Hazardous mater ial classification group. On the

Hazardous mater ial classification groupHazardous mater ial classification group page, you can create any number of groups and configure each by

using the fields that are described in the following table.

A hazardous material class is typically mapped to the list of classes that is provided in the regulation that you're

conforming to. For example, US regulation CFR 49 lists "class 3" as flammable and combustible liquids. You can
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Class code Enter a code to identify this class. You define this code for
the item. It will then be used in lookup lists when you assign
a hazardous material class to a released item.

Description Enter a description of the class.

Hazardous material divisions

set up the classes that are relevant to the materials that you must classify.

Each class will be assigned to a material setup in the materials list that is related to the regulation. You will

assign a class to each released item as required, to describe the hazardous nature of a product.

This setup data isn't specific to each legal entity. Therefore, you can have a common set of hazardous material

information that is shared among all your legal entities.

Hazardous material classes work together with divisions, groups, and compatibility groups in the following way:

When you assign a hazardous material class to a released item, you must also assign a hazardous material

division.

You can use hazardous material classes together with hazardous material classification groups to establish a

template of codes for setting up items.

You can use hazardous material compatibility groups to establish which hazardous material classes and

divisions can be shipped together.

To set up hazardous material classes, go to Product information management > Setup > HazardousProduct information management > Setup > Hazardous

mater ial shipping documentation > Hazardous mater ial classmater ial shipping documentation > Hazardous mater ial class . On the Hazardous mater ial classHazardous mater ial class  page,

you can create any number of classes and configure each by using the fields that are described in the following

table.

A hazardous material division is a subset of a hazardous material class. You must assign both a division and a

class to every product that includes hazardous materials.

For classes that don't have any divisions, create a division where the code is 0. For example, in the IATA

regulation, class-7 radioactive materials have no subdivisions. In this case, you will create a 0 division that you

can associate with a released product when you assign the class.

This setup data isn't specific to each legal entity. Therefore, you can have a common set of hazardous material

information that is shared among all your legal entities.

Hazardous material divisions work together with classes, groups, and compatibility groups in the following

ways:

When you assign a hazardous material division to a released item, you must also assign a hazardous

material class.

You can use hazardous material divisions together with hazardous material classification groups to establish

a template of codes for setting up items.

You can use hazardous material compatibility groups to establish which hazardous material classes and

divisions can be shipped together.

To set up hazardous material divisions, go to Product information management > Setup > HazardousProduct information management > Setup > Hazardous

mater ial shipping documentation > Hazardous mater ial divisionmater ial shipping documentation > Hazardous mater ial division. On the Hazardous mater ialHazardous mater ial

divisiondivision page, you can create any number of divisions and configure each by using the fields that are described

in the following table.
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Division Enter a code to use as a reference number for the division.

Description Enter a description of the division.

Class Look up and assign the class that the division belongs to.

Hazardous material compatibility groups

Hazardous material compatibility group headerHazardous material compatibility group header
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Compatibility group Enter a code to identify the compatibility group

Description Enter a description of the compatibility group.

Compatibility group detailsCompatibility group details

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Class Select a hazardous material class that is compatible with all
other classes in the group.

Division Select a hazardous material division that belongs to the
selected class.

Hazardous material specification values

Hazardous material compatibility groups establish which hazardous material classes and divisions can be

shipped together. When operators create warehouse loads or shipments, they can run a compatibility check that

will issue a warning if the load or shipment includes items that don't all belong to the same compatibility group.

This setup data isn't specific to each legal entity. Therefore, you can have a common set of hazardous material

information that is shared among all your legal entities.

To set up hazardous material compatibility groups, go to Product information management > Setup >Product information management > Setup >

Hazardous mater ial shipping documentation > Hazardous mater ial compatibility groupHazardous mater ial shipping documentation > Hazardous mater ial compatibility group. On the

Hazardous mater ial compatibility groupHazardous mater ial compatibility group page, you can create any number of compatibility groups and

configure each by using the fields that are described in the following subsections.

Each compatibility group has a code and a description. The following table describes the fields that are available

on the header.

Each compatibility group establishes a list of classes and divisions of hazardous materials that can be shipped

together.

Microsoft Dynamics 365 Supply Chain Management provides several types of hazardous material specifications.

For each type, you must establish a centralized set of values for each relevant field. Users can then select among

those values when they configure hazardous material definitions or released products. Supply Chain

Management provides a collection of pages where you can establish the values. Each page is dedicated to one

type of specification. For a description of each available specification and information about how to establish the

values that are available for it, see the following subsections.



  

  

Hazardous material emergency responseHazardous material emergency response

Hazardous material identificationHazardous material identification
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Identification Enter a code to use as a reference number that identifies this
class of hazardous material.

Description Enter a description of this class.

Restrict from air transport Select this check box to indicate that this class of hazardous
material should not be transported by air.

Restrict from sea transport Select this check box to indicate that this class of hazardous
material should not be transported by sea.

Hazardous material labelHazardous material label

One example of a hazardous material specification is the stowage code, which specifies how a given material

can be stored during transport. By using the information in this section, you will establish a central collection of

stowage codes. This collection will then be presented to users in a drop-down list when they set the stowage

code for a released product.

These hazardous material specification values aren't specific to each legal entity, Therefore, you can have a set of

common values that are shared among all your legal entities.

You will use material codes to establish common collections of settings for each specification as it applies to a

given regulation. You can then apply the appropriate code to each released product as required. For information

about how to apply a hazardous material code to a specific released product, and how to configure individual

settings of that product for any specification that is described here, see Hazardous materials in products, orders,

shipments, and loads.

The Hazardous material emergency response specification indicates what should be done if something goes

wrong while a product that contains a given hazardous material is being transported.

To set up values for this specification, go to Product information management > Setup > HazardousProduct information management > Setup > Hazardous

mater ial shipping documentation > Hazardous mater ial emergency responsemater ial shipping documentation > Hazardous mater ial emergency response. On the HazardousHazardous

mater ial emergency responsemater ial emergency response page, you can create any number of values and configure each with a

classification code and a short description.

The Hazardous material identification specification identifies the class or nature of a hazardous material. The

value is typically a code that is based on a United Nations (UN) standard. Each class is identified by a code and a

description, and it can set limits on transport methods. For example, to identify a flammable item or material,

you create a hazardous material class that uses the code FL and the description Flammable. You also specify that

the class must not be transported by air.

To set up values for this specification, go to Product information management > Setup > HazardousProduct information management > Setup > Hazardous

mater ial shipping documentation > Hazardous mater ial identificationmater ial shipping documentation > Hazardous mater ial identification. On the Hazardous mater ialHazardous mater ial

identificationidentification page, you can create any number of values and configure each by using the fields that are

described in the following table.

The Hazardous material label specification identifies the dangerous goods label that must be applied to relevant

released products. The labels themselves will describe how the product should be handled. For example, you

have a product that contains a poisonous gas. In this case, you set up a label code that represents the poisonous

gas label. You also build your business process so that it looks up this value when you ship products.

To set up values for this specification, go to Product information management > Setup > HazardousProduct information management > Setup > Hazardous



  

    

  

  

    

  

Hazardous material packing descriptionsHazardous material packing descriptions

Hazardous material packing groupHazardous material packing group

Hazardous material packing instructionHazardous material packing instruction

Hazardous material stowageHazardous material stowage

Hazardous material transport categoryHazardous material transport category

Hazardous material technical nameHazardous material technical name

material shipping documentation > Hazardous mater ial labelmater ial shipping documentation > Hazardous mater ial label . On the Hazardous mater ial labelHazardous mater ial label  page,

you can create any number of labels and configure each with an identifying code and a short description.

The Hazardous material packing descriptions specification indicates how a hazardous item must be packed. For

example, it might have to be packed in a specific type of steel drum or some other type of special packaging.

To set up values for this specification, go to Product information management > Setup > HazardousProduct information management > Setup > Hazardous

mater ial shipping documentation > Hazardous mater ial packing descr iptionsmater ial shipping documentation > Hazardous mater ial packing descr iptions . On the HazardousHazardous

mater ial packing descr iptionsmater ial packing descr iptions  page, you can create any number of packing descriptions and configure each

with an identifying code and a short description.

The Hazardous material packing group specification identifies the packing group for a hazardous item. The

packing group lets you define a code and a description to indicate how hazardous material items must be

packed during transportation or shipment. The packing group is assigned to the item through the ItemItem

hazardous mater ialshazardous mater ials  page.

To set up values for this specification, go to Product information management > Setup > HazardousProduct information management > Setup > Hazardous

mater ial shipping documentation > Hazardous mater ial packing groupmaterial shipping documentation > Hazardous mater ial packing group. On the Hazardous mater ialHazardous mater ial

packing grouppacking group page, you can create any number of packing groups and configure each with an identifying

code and a short description.

The Hazardous material packing instruction specification identifies packing instructions that must be followed

when a given hazardous item is prepared for transportation by air.

To set up values for this specification, go to Product information management > Setup > HazardousProduct information management > Setup > Hazardous

mater ial shipping documentation > Hazardous mater ial packing instructionmater ial shipping documentation > Hazardous mater ial packing instruction. On the HazardousHazardous

mater ial packing instructionmater ial packing instruction page, you can create any number of packing instruction identifiers and

configure each with an identifying code and a short description.

The Hazardous material stowage specification indicates how a product must be stored on a ship when it's

transported by sea freight.

To set up values for this specification, go to Product information management > Setup > HazardousProduct information management > Setup > Hazardous

mater ial shipping documentation > Hazardous mater ial stowagematerial shipping documentation > Hazardous mater ial stowage. On the Hazardous mater ialHazardous mater ial

stowagestowage page, you can create any number of stowage identifiers and configure each with an identifying code

and a short description.

The Hazardous material transport category specification is typically used to group similar hazardous products

on reports. For example, transport categories are used on the Shipment summar yShipment summar y  report, which you can print

from the warehouse shipment record.

To set up values for this specification, go to Product information management > Setup > HazardousProduct information management > Setup > Hazardous

mater ial shipping documentation > Hazardous mater ial transpor t categor ymater ial shipping documentation > Hazardous mater ial transpor t categor y . On the HazardousHazardous

mater ial transpor t categor ymater ial transpor t categor y  page, you can create any number of transport categories and configure each

with a display name and a short description.

The Hazardous material technical name specification can be used to provide a commonly used or internal

company name that describes each material.

To set up values for this specification, go to Product information management > Setup > HazardousProduct information management > Setup > Hazardous



  Hazardous material tunnelHazardous material tunnel
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material shipping documentation > Hazardous mater ial technical namematerial shipping documentation > Hazardous mater ial technical name. On the Hazardous mater ialHazardous mater ial

technical nametechnical name page, you can create any number of technical names and configure each with a display name

and a short description.

The Hazardous material tunnel specification limits the types of tunnels that a hazardous material can be

transported through by identifying the types of tunnels that must be used. Tunnel categories are established by

applicable regulations for hazardous material transport. This specification usually applies only to road transport.

To set up values for this specification, go to Product information management > Setup > HazardousProduct information management > Setup > Hazardous

mater ial shipping documentation > Hazardous mater ial tunnelmater ial shipping documentation > Hazardous mater ial tunnel . On the Hazardous mater ial tunnelHazardous mater ial tunnel

page, you can create any number of tunnel identifiers and configure each with an identifying code and a short

description.
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Set hazardous material specifications for products

Item hazardous materials headerItem hazardous materials header

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Item number The released product that you're working with.

Regulation code Select the hazardous material regulation that applies to the
product. The regulation defines how the printed shipping
text is created for an item and the associated modes of
delivery. After it's assigned, the code can't be edited on this
page. However, you can assign a new regulation code by
selecting NewNew.

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

This topic explains how to set hazardous material properties for released products, how to put stock limits on

hazardous items, and how to include hazardous materials in a sales order, shipment, or load.

After you've defined a hazardous material regulation and set up the related reference codes as described in Set

up hazardous materials, you can associate this information with released items. The shipping text for shipping

documents will be drawn from the hazardous materials information for the released items.

As part of the process of associating a released item with a hazardous material, you must specify the regulation

code and the material. Different regulation codes might be associated with an item, depending on the modes of

transport, and you can associate multiple regulations and material codes with each item.

To set up a released product as a hazardous material, follow these steps.

1. Go to Product information management > Products > Released productsProduct information management > Products > Released products .

2. Select or create a product to open its Released product detailsReleased product details  page.

3. On the Manage inventor yManage inventor y  FastTab, set the Hazardous mater ialHazardous mater ial  option to YesYes . This setting identifies the

item as a dangerous good and is used when shipping documentation is printed.

4. On the Action Pane, on the Manage inventor yManage inventor y  tab, in the ComplianceCompliance group, select Item hazardousItem hazardous

mater ialmater ial .

5. Fill in the Item hazardous mater ialsItem hazardous mater ials  page for the selected item by using the fields that are described in the

following subsections.

The following table describes the fields that are available at the top of the Item hazardous mater ialsItem hazardous mater ials  page.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/hazmat-items.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version


    

Material code (Optional) Select the hazardous material code that applies to
the product. The material code provides a template that
includes default values for many other fields on this page.
When you select a code, all its hazardous materials
specifications will be copied to the current product. However,
the system first prompts you to confirm that item material
data should be filled in from the material code.

Group code (Optional) Select the hazardous material classification group
code that applies to the product. As for the Material codeMaterial code
field, when you select a code, all its hazardous materials
specifications will be copied to the current product. However,
the system first prompts you to confirm that item class
group data should be filled in from the group code.
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Descriptions FastTabDescriptions FastTab

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Proper shipping name Enter the standard description for the material, as specified
by the applicable regulation. You can provide translations for
this value on the Item ship text translationItem ship text translation FastTab, as
described in the next section.

Technical name Select the common or generic name for the material. This
name might be a name that your company uses internally
for the material.

N.O.S. Select this check box to indicate that the Proper shippingProper shipping
namename value is a not-otherwise-specific (N.O.S.) shipping
name for the item. N.O.S. shipping names are used for
groups of similar chemicals and materials that have specific
end uses, but that might not be listed by name in the
hazmat table in a specific regulation.

Item ship text translation FastTabItem ship text translation FastTab

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Language The language code that the row uses. For example, pt-brpt-br
indicates Brazilian Portuguese.

Shipping print text The translated Proper shipping nameProper shipping name value in the
language that the row uses.

The following table describes the fields that are available on the Descr iptionsDescr iptions  FastTab.

The Item ship text translationItem ship text translation FastTab contains a grid that shows translations of the Proper shipping nameProper shipping name

values that are defined for the primary language on the Descr iptionsDescr iptions  FastTab. These translations can be used in

shipping print text for one or more additional languages.

The following table describes the fields that are available on the Item ship text translationItem ship text translation FastTab.

To add or edit a translation, select TranslationsTranslations  above the grid to open Text translationsText translations  page. Then follow

one of these steps:

To add a new translation, on the Action Pane, select AddAdd. Select the language to add, and then, in the



                Material management FastTabMaterial management FastTab
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Class Select the hazardous material class that the product belongs
to, as defined by the regulation that you're conforming to.
You must assign both a division and a class to every product
that includes hazardous materials.

Description The description that is defined for the class that is selected in
the ClassClass  field. This field is read-only.

Division Select the hazardous material division that the product
belongs to, as defined by the regulation that you're
conforming to. The division is a subset of the class. You must
assign both a division and a class to every product that
includes hazardous materials.

Identification Select the hazardous material identification code. Typically,
this code is based on a United Nations (UN) standard.

Packing group Select the packing group that applies to the current item.

Description The description that is defined for the group that selected in
the Packing groupPacking group field. This field is read-only.

Packing Descriptions Select the applicable packing description code. This code
references a description that indicates how the product must
be packed.

Hazardous material labels Select a code that references the applicable dangerous
goods label that should be applied to the product.

Limited quantity Set this option to YesYes to report the total product weight
that is included in each load and on each load line.

Quantity Enter the quantity of hazardous material in the product, in
the specified unit. This value will be used to calculate the
total hazardous material score for loads and shipments that
include the product.

Multiplier Enter the multiplier that is applied when the hazardous
material score is calculated for each load line that includes
the product. This value is specified by the applicable
regulation, according to the type of hazardous material that
is contained in the product.

Unit Select the unit of measure that applies to the quantity of
hazardous material in the product, as specified in the
QuantityQuantity  field. This value will be used to calculate the total
hazardous material score for loads and shipments that
include the product.

Translated textTranslated text field, enter the translated text.

To edit an existing translation, select a target language in the LanguageLanguage field, and edit the translated text in

the Translated textTranslated text field, as required.

The following table describes the fields that are available on the Mater ial managementMater ial management FastTab.



How the hazardous material score is calculatedHow the hazardous material score is calculated

How the hazardous material weight is calculatedHow the hazardous material weight is calculated

Transport information FastTabTransport information FastTab

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Transport category Select the related transport category.

Tunnel Code Select the related tunnel restriction code for the item.

Hazardous material stowage Select the reference code that is used for sea freight stowage
handling when the item is shipped by sea freight.

Aircraft type Select the aircraft restriction that applies for the material
when it's shipped by air freight.

Packing - cargo aircraft only Based on the value that you selected in the Aircraft typeAircraft type
field, select the packing instructions code that applies when
the product can be shipped only by cargo aircraft.

Several of the values that are specified on the Mater ial managementMater ial management FastTab for a product are used to

calculate a hazardous material score for each load line that includes that product. The score is calculated by

using the following formula:

Hazardous material score = <LineQty> × <HazmatQty> × <UnitConversion> × <Multiplier>

Here is a key to the formula:

<LineQty> is the quantity of product that is specified for a load line.

<HazmatQty> is the quantity of hazardous material that is specified for a product in the QuantityQuantity  field on

the Mater ial managementMater ial management FastTab.

<UnitConversion> is a conversion factor for converting between the unit that is used for the load line

quantity and the unit that is specified for a product in the UnitUnit field on the Mater ial managementMater ial management FastTab.

<Multiplier> is the multiplier that is specified for a product in the MultiplierMultiplier  field on the Mater ialMater ial

managementmanagement FastTab.

This score is reported for each load line that contains a product where these values are specified. For more

information, see the Shipments that include hazardous materials and Loads that include hazardous materials

sections later in this topic.

Loads and load lines that contain products where the L imited quantityL imited quantity  option on the Mater ial managementMater ial management

FastTab is set to YesYes  will show the total hazardous material weight, as described in the Shipments that include

hazardous materials and Loads that include hazardous materials sections later in this topic. The hazardous

material weight is calculated by using the following formula:

Hazardous material weight = <LineQty> × <ProductWeight> × <UnitConversion>

Here is a key to the formula:

<LineQty> is the quantity of product that is specified for a load line.

<ProductWeight> is the net weight that is specified for the product, in the inventory unit that is specified for

the product.

<UnitConversion> is a conversion factor for converting between the unit that is used for the load line

quantity and the inventory unit that is used for <ProductWeight>.

The following table describes the fields that are available on the Transpor t informationTranspor t information FastTab.



 

Packing - passenger and cargo aircraft Based on the value that you selected in the Aircraft typeAircraft type
field, select the packing instructions code that applies when
the product can be shipped by either cargo aircraft or
passenger aircraft.

IATA Star Set this option to YesYes to indicate that the air transport
specifications that are entered on this FastTab are related to
the International Air Transport Association (IATA) dangerous
goods standard. This field is for informational purposes only.

Emergence response Select the code that references instructions for handling the
material in an emergency.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Environmental information FastTabEnvironmental information FastTab
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Environmentally dangerous Set this option to YesYes to indicate that the product is
environmentally dangerous. Use this field for your own
reporting purposes.

Marine pollutant Set this option to YesYes to indicate that the product is a
marine pollutant. Use this field for your own reporting
purposes.

Set stock limits for hazardous products

Sales order transactions that include hazardous materials

The following table describes the fields that are available on the Environmental informationEnvironmental information FastTab.

For safety reasons, you might have to limit the total amount of a given product that can be stocked at a single

location. To set stock limits for a released product, follow these steps.

1. Go to Product information management > Products > Released productsProduct information management > Products > Released products .

2. Select a product to open its Released product detailsReleased product details  page.

3. On the Action Pane, on the Manage inventor yManage inventor y  tab, in the ComplianceCompliance group, select Repor ting detailsRepor ting details .

4. In the Hazardous stock limitHazardous stock limit and Hazardous warning limitHazardous warning limit fields, set appropriate values for the selected

product.

The Hazardous mater ial stock limitHazardous mater ial stock limit report lets you monitor the stock levels of the hazardous materials in

your warehouse locations, to make sure that they remain under the safe limits that are established here. For

more information, see Hazardous material stock limit report.

To include a product that is classified as a hazardous material on a sales order, you must associate the relevant

shipping carrier with the sales order. Open the sales order, and then, on the Deliver yDeliver y  FastTab, set the ShippingShipping

carr iercarr ier  and Carr ier  ser viceCarr ier  ser vice fields as required.

The shipping carrier is also associated with the mode of delivery. Therefore, you must make sure that this

information is aligned with the hazardous material regulation. In other words, the mode of delivery that is

specified in the hazardous material regulation must match the specifications on the sales order header. In this

way, the regulation, shipping carrier, and service are connected to the shipment lines that are used on a sales

order.



  

  

Shipments that include hazardous materials
View hazardous material scores for each shipment lineView hazardous material scores for each shipment line

Check for compatibility among hazardous materials that are included in a shipmentCheck for compatibility among hazardous materials that are included in a shipment

Loads that include hazardous materials
View hazardous material scores for each load lineView hazardous material scores for each load line

After a sales order is finalized and ready to be shipped, it can be released to the warehouse to indicate the

transfer between sales and warehouse operations.

The Shipment detailsShipment details  page for a shipment shows the total hazardous material weight and point values that

have been calculated for each load line that is included in that shipment. To view the scores and weights, follow

these steps.

1. Go to Warehouse management > Shipments > All shipmentsWarehouse management > Shipments > All shipments .

2. Select a shipment to open its Shipment detailsShipment details  page.

3. On the Load linesLoad lines  FastTab, inspect the lines. For each line, you will see the hazardous material

calculations in the following fields:

Hazardous mater ial pointsHazardous mater ial points  – This field shows the hazardous material score for the load line. The

value is calculated according to the rules and values that have been established for the applicable

regulation and in the released product setup. The calculation takes the quantity on the load line and

references the multiplier in the material management setup for the released product.

L imited quantity net weightLimited quantity net weight – For products that are marked as limited-quantity products because

of their hazardous material content, this field shows the total net weight of hazardous content that is

included on the load line. The calculation is based on the products that are marked as hazardous

materials in the released product setup. If an item is marked as a limited-quantity item, the calculation

takes the quantity on each load line and references the weight in the material management setup for

the released product.

The system can evaluate whether all the hazardous materials that are included in a shipment are suitable to be

shipped together. To evaluate compatibility, the system checks the compatibility group that is assigned to each

product that is included in the shipment. For more information, see Hazardous material compatibility groups.

To run the compatibility check, follow these steps.

1. Go to Warehouse management > Shipments > All shipmentsWarehouse management > Shipments > All shipments .

2. Select a shipment to open its Shipment detailsShipment details  page.

3. On the Action Pane, on the ShipmentsShipments  tab, in the ActionsActions  group, select Compatibility checkCompatibility check .

You receive a message that informs you of the results of the check.

The Load detailsLoad details  page for a load shows the total hazardous material weight and point values that have been

calculated for that load and for each load line. To view the scores and weights, follow these steps.

1. Go to Warehouse management > Shipments > All loadsWarehouse management > Shipments > All loads .

2. Select a load to open its Load detailsLoad details  page. (You can also open load details by selecting a link from a

related shipment.)

3. On the LoadLoad FastTab, you can review the total hazardous material scores and weights for the whole load

by inspecting the following fields:

Hazardous mater ial pointsHazardous mater ial points  – This field shows the hazardous material score for the load. The value



Check for compatibility among hazardous materials that are included in a loadCheck for compatibility among hazardous materials that are included in a load

NOTENOTE

is calculated according to the rules and values that have been established for the applicable regulation

and in the released product setup. The calculation takes the quantity that is included in the load and

references the multiplier in the material management setup for the released product.

L imited quantity net weightLimited quantity net weight – For products that are marked as limited-quantity products because

of their hazardous material content, this field shows the total net weight of hazardous content that is

included in the load. The calculation is based on the products that are marked as hazardous materials

in the released product setup. If an item is marked as a limited-quantity item, the calculation takes the

quantity in each load and references the weight in the material management setup for the released

product.

4. To review the scores and weights for individual lines, select the Load linesLoad lines  FastTab. The values that are

provided for each line resemble the values that are provided for the whole load, as described in the

previous step.

The system can evaluate whether all the hazardous materials that are included in a load are suitable to be

shipped together. To evaluate compatibility, the system checks the compatibility group that is assigned to each

product that is included in the load. For more information, see Hazardous material compatibility groups.

To run the compatibility check, follow these steps.

1. Go to Warehouse management > Shipments > All loadsWarehouse management > Shipments > All loads .

2. Select a shipment to open its Load detailsLoad details  page. (You can also open load details by selecting a link from a

related shipment.)

3. On the Action Pane, on the LoadsLoads  tab, in the ActionsActions  group, select Compatibility checkCompatibility check .

You receive a message that informs you of the results of the check.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

Set up hazardous materials reporting

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

Microsoft Dynamics 365 Supply Chain Management provides various reports that are related to hazardous

materials. Many of these reports are required so that you remain compliant with various hazardous material

regulations during shipping and storage.

All these reports, except the Multimodal dangerous goodsMultimodal dangerous goods  report, use the mode of delivery that is defined

for the shipment to find the regulation that should be used to print the shipping text for items. The mode of

delivery is associated with the shipping carrier and the carrier service. Therefore, you must set up a shipping

carrier and carrier service, and link them to a mode of delivery. The mode of delivery is related to the hazardous

materials regulation.

The following illustration shows the sequence of activities that occur when the system generates hazardous

materials reports.

Usually, if you ship items that contain hazardous materials, you must generate specific reports to help preserve

safety and comply with hazardous materials regulations. To set up your reports, follow these steps.

SEC T IO NSEC T IO N F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Multimodal Dangerous Goods Regulation code Select the regulation that should be
used when a MultimodalMultimodal
dangerous goodsdangerous goods report is
generated.

Hazardous Material stock limits Regulation code Select the regulation that should be
used when stock limits are
evaluated.

1. Go to Warehouse management > Setup > Warehouse management parametersWarehouse management > Setup > Warehouse management parameters .

2. Open the Repor tsRepor ts  tab. On the Hazardous mater ials repor t parameterHazardous mater ials repor t parameter  FastTab, set the following

fields.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/hazmat-reports.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version


  

Hazardous materials report

Hazardous material stock limit report

Carriage of merchandise by road CMR group product CMR stands for "carcinogenic,
mutagenic, and reprotoxic
substances." Set this option to YesYes
to configure the system to print
specific warnings and messages that
are related to the handling of these
substances.

Carriage of merchandise by road Hazardous material group
description

Enter the text of specific warnings
that are related to CMR and
carriage of merchandise by road.
This text will be included on the
report.

Shippers declaration Warning Enter the text of a warning message
that should be printed on the
shipper's declaration form (for
example, "Warning: Dangerous
Goods, Flammable").

Shippers declaration Footer declaration Enter the text of a message that
should be printed at the bottom of
the shipment declaration document.

Hazardous goods report language Hazardous goods domestic report
language

Select the default language for
hazardous materials reports that are
associated with domestic shipments.

Hazardous goods report language Hazardous goods export report
language

Select the default language for
hazardous materials reports that are
associated with international
shipments.

SEC T IO NSEC T IO N F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

The Hazardous mater ialsHazardous mater ials  report shows a list of all items that have been set up and defined so that they have

dangerous goods information. You can use this report to monitor and review the information that you must

maintain. The page for the report shows a limited selection of fields from the hazardous material setup.

However, you can personalize it to add additional fields as you require.

To view this report, go to Product information management > Inquir ies and repor ts > HazardousProduct information management > Inquir ies and repor ts > Hazardous

mater ial shipping documentation > Hazardous mater ialsmater ial shipping documentation > Hazardous mater ials .

The Hazardous mater ial stock limitHazardous mater ial stock limit report lets you monitor the stock levels of the hazardous materials in

your warehouse locations, to make sure that they remain under established, safe limits. These limits come from

the limits that are defined for each released product.

To view this report, go to Product information management > Inquir ies and repor ts > HazardousProduct information management > Inquir ies and repor ts > Hazardous

shipping documentation > Hazardous mater ial stock limitsshipping documentation > Hazardous mater ial stock limits .

For more information about how to set stock limits on a released product, see Set stock limits for hazardous

products.

The regulation that is used for stock limits is defined on the Warehouse management parametersWarehouse management parameters  page. Go



Verified gross mass report

Multimodal dangerous goods report

Shippers declaration report

Carriage of merchandise by road report

Shipment summary report

to Warehouse management > Setup > Warehouse management parametersWarehouse management > Setup > Warehouse management parameters , and then, on the Repor tsRepor ts

tab, in the Hazardous mater ials stock limitHazardous mater ials stock limit, specify a regulation code. For more information, see the Set up

hazardous materials reporting section earlier in this topic.

The Verified gross massVerified gross mass  report lets you print information about the weight of a shipment.

To generate and print this report, go to Warehouse management > Shipments > All shipmentsWarehouse management > Shipments > All shipments , and open

the relevant shipment. Then, on the Action Pane, on the ShipmentsShipments  tab, in the Hazardous mater ialsHazardous mater ials

documentdocument group, select Verified gross massVerified gross mass .

The Multimodal dangerous goodsMultimodal dangerous goods  report is provided for shipments that must be moved by using a

combination of transport methods. It's typically used when a shipment is moved first by road and later by sea.

To generate and print this report, go to Warehouse management > Shipments > All shipmentsWarehouse management > Shipments > All shipments , and open

the relevant shipment. Then, on the Action Pane, on the ShipmentsShipments  tab, in the Hazardous mater ialsHazardous mater ials

documentdocument group, select Multi model dangerous goodsMulti model dangerous goods .

When you generate this report, the information is saved so that you can edit it and/or reprint the report if you

must. To edit a generated report, go to Warehouse management > Inquir ies and repor ts > HazardousWarehouse management > Inquir ies and repor ts > Hazardous

mater ials shipping documentation > Multimodal dangerous goodsmater ials shipping documentation > Multimodal dangerous goods , and find the relevant report in the

list. After you've finished editing the content as you require, select Pr intPr int on the Action Pane to print the report.

The Shippers declarationShippers declaration report lets you print information that is related to a declaration of the materials that

are included in the shipment.

To generate and print this report, go to Warehouse management > Shipments > All shipmentsWarehouse management > Shipments > All shipments , and open

the relevant shipment. Then, on the Action Pane, on the ShipmentsShipments  tab, in the Hazardous mater ialsHazardous mater ials

documentdocument group, select Shippers declarationShippers declaration.

The Carr iage of merchandise by roadCarr iage of merchandise by road report resembles a bill of lading but is typically used for road

transportation in Europe under the Agreement concerning the International Carriage of Dangerous Goods by

Road (ADR) regulations. This report uses the shipping print text for an item unless you set the HazardousHazardous

mater ial group descr iptionmater ial group descr iption field on the Warehouse management parametersWarehouse management parameters  page.

To generate and print this report, go to Warehouse management > Shipments > All shipmentsWarehouse management > Shipments > All shipments , and open

the relevant shipment. Then, on the Action Pane, on the ShipmentsShipments  tab, in the Hazardous mater ialsHazardous mater ials

documentdocument group, select Carr iage of merchandise by roadCarr iage of merchandise by road.

When you generate this report, the information is saved so that you can edit it and/or reprint the report if you

must. To edit a generated report, go to Warehouse management > Inquir ies and repor ts > HazardousWarehouse management > Inquir ies and repor ts > Hazardous

mater ials shipping documentation > Carr iage of merchandise by roadmaterials shipping documentation > Carr iage of merchandise by road, and find the relevant report in

the list. After you've finished editing the content as you require, select Pr intPr int on the Action Pane to print the

report.

The Shipment summar yShipment summar y  report provides information that is summarized by the transport category that is

related to the released items.



bill of lading report

Packing list report

NOTENOTE

To generate and print this report, go to Warehouse management > Shipments > All shipmentsWarehouse management > Shipments > All shipments , and open

the relevant shipment. Then, on the Action Pane, on the ShipmentsShipments  tab, in the Hazardous mater ialsHazardous mater ials

documentdocument group, select Shipment summar yShipment summar y .

When the hazardous materials feature is turned on in your system, the bill of ladingbill of lading report includes a

Hazardous mater ialsHazardous mater ials  column that indicates whether a load includes hazardous materials. This report is

available from the All loadsAll loads  page, as usual.

When the hazardous materials feature is turned on in your system, packing lists include additional information

that is related to the shipping print text for an item. This report is available from the All loadsAll loads  page, as usual.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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What product-related data can be translated?

Where can I view the translated information?

How do I create translations for product-related information?

This topic describes how to manage translations for products, product dimension values, and product attributes.

You can create translations for the following product-related information:

Names and descriptions of products.

Descriptions, friendly names, and help text of product attribute values.

Names and descriptions of product dimension values.

You can translate the product-related information into any language that is available from the Text translationText translation

page. For more information, see the following section How do I created translations for product-relatedHow do I created translations for product-related

informationinformation.

You can view translations of product-related information in any external source document, such as an invoice,

that uses a language where translations are available.

To create translations for a product, follow these steps:

1. Click Product information managementProduct information management > CommonCommon > Released productsReleased products .

2. Select a product, and on the Action Pane, in the LanguagesLanguages  group, click TranslationsTranslations .

3. In the Text translationText translation page, in the LanguageLanguage field, select a language. To add more languages, expand the

LanguageLanguage field, and then click OKOK.

4. In the Translated textTranslated text group, enter translations in the Descr iptionDescr iption and Product nameProduct name fields.

To create translations for product attributes, follow these steps:

1. Click Product information managementProduct information management > CommonCommon > Released productsReleased products .

2. Under SetupSetup, click Attr ibutesAttr ibutes , and then click Attr ibutesAttr ibutes .

3. In the Attr ibutesAttr ibutes  page, click TranslateTranslate.

4. In the Text translationText translation page, in the LanguageLanguage field, select a language. To add more languages, expand the

LanguageLanguage field, and then click OKOK.

5. In the Translated textTranslated text group, enter translations in the Descr iptionDescr iption, Fr iendly nameFriendly name, and Help textHelp text fields.

To create translations for product dimension values, follow these steps:

1. Click Product information managementProduct information management > CommonCommon > Released productsReleased products .

2. Select a product, and then click Product dimensionsProduct dimensions .

3. Select one of the links for the product dimensions: ConfigurationsConfigurations , S izesSizes , ColorsColors , or StyleStyle.

4. Select a dimension value and then click TranslateTranslate.

5. In the Text translationText translation page, in the LanguageLanguage field, select a language. To add more languages, expand the

LanguageLanguage field, and then click OKOK.

6. In the Translated textTranslated text group, enter translations in the NameName and Descr iptionDescr iption fields.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/translations-product-related-information.md


Can the names of product variants be translated?

T IPT IP

To set the preferred language of a customer, follow these steps:

What happens if a customer has a preferred language for which no
translations are available?

Can I manage translations for a series of dimension values at the same
time?

Product variants are based on the dimensions of a released product. Product variant names are based on a

combination of dimension values. When the dimension values that are associated with a product variant are

translated, the name of the product variant appears in the translated version.

ExampleExample

Your product is a T-shirt that comes in different sizes and colors and the variant names are based on the

following details:

Product number: #3

Dimensions: Size and color

Size dimension values: Small, Medium, Large

Color dimension values: Red, Green, Black

The name of a product variant that is based on the dimension values Small and Red is #3:Small:Red#3:Small:Red.

A customer wants to buy some small, red T-shirts and the name of the T-shirt must appear in French on the

invoice. You translate the dimension values, Small and Red, into French, and the name of the product variant is

#3:Petit:Rouge#3:Petit:Rouge.

1. Click Sales and marketingSales and marketing > CommonCommon > CustomersCustomers > AllAll customerscustomers .

2. Double-click a customer to open the CustomersCustomers page. On the GeneralGeneral tab, in the LanguageLanguage field, select the
languagelanguage.

If translations are not available in the customer’s preferred language, the names and descriptions are displayed

in the global language of your own company.

Dimension values are product specific and you can manage the translations for the dimension values for each

product. However, if you create a dimension value group and create translations for the values in the value

group, it is easier to manage the translations.

ExampleExample

Your company produces T-shirts in different styles, and each style is available in the sizes Small, Medium, and

Large. The sizes are collected in one dimension value group. When a new T-shirt style is added, you can

associate it with the dimension value group that is used for sizes, so that all the sizes are available for the

product. You can also add or change translations for the sizes in the dimension value group at any time.

A dimension value that is associated with a product through a dimension variant group must be maintained

from the product variant group.

To create a dimension value group, follow these steps:

1. Click Product information managementProduct information management > SetupSetup > Variant groupsVariant groups .



When can translations of product-related information be managed?

NOTENOTE

2. Select S izeSize groupsgroups , Color groupsColor groups , or Style groupsStyle groups .

3. Click NewNew , and then enter a name for the group in the S izeSize groupgroup, Color groupColor group, or Style groupStyle group field. Click

SizesSizes , ColorsColors , or StylesStyles  to create lines for the groups.

4. In the S izeSize groupgroup lines, ColorColor  groupgroup lineslines , or Style group linesStyle group lines  page, click NewNew , and then create the

sizes, colors, and styles for the groups.

To manage translations for values in a dimension value group, follow these steps:

1. Follow the steps in the previous procedure for creating a dimension value group to open the S ize groupSize group

lineslines , Color group linesColor group lines , or Style group linesStyle group lines  page.

2. Click Text translationText translation. In the Text translationText translation page, in the Translated textTranslated text group, enter translations in the

NameName and Descr iptionDescr iption fields.

Translations of product-related information can be managed at any time. When translations are updated for a

dimension value that is associated with a product, the product information is updated, regardless of whether the

product has transactions.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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How search works

ExamplesExamples

P RO DUC T  T Y P EP RO DUC T  T Y P E P RO DUC T  N A M EP RO DUC T  N A M E
DISP L AY  P RO DUC TDISP L AY  P RO DUC T
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Distinct product SpeakerMidRange D0001 D0001 NA

Product variant Active speaker D0010:::Black: D0010 000005

Product variant Active speaker D0010:::White: D0010 White

Use the Item numberItem number  field to search for products and product variants when you manually create a sales order

line or a purchase order line. This lets you quickly find product variants when you only have the configuration

string or one of the product dimensions available.

Sometimes, having too much of something is not the best situation to be in, and this is especially true if you sell

a number of products that are similar, and you are trying to remember item numbers or product search names

in order to find the right product to put on a sales order. You can use the Item numberItem number  field on a sales order

line or a purchase order line as a search field. You can enter any part of a product name, number, or dimension

and get a lookup that displays all the items that match the search word.

When you search for products or product variants, it is important to understand how the search feature finds

the products that match the text that you enter. The key search rules in delivering search results are:

Search results will return any matching record, disregarding the field that the search text is entered in.

The search text needs to be present in the matching record in its full length.

A match will occur even if the search text is found in the middle of a text string in the matching record. It does

not have to appear in the beginning of a text string.

The search text is treated as a single text string even if it contains white space.

The following examples use products and product variants to illustrate how search is handled in various

scenarios. Prerequisite:Prerequisite: Under Sales and marketing > Setup > Search > Search parameters > SearchSales and marketing > Setup > Search > Search parameters > Search

typetype, select the Full matchFull match option.

If you type 'speak' in the Item numberItem number  field, you will get all the products above as a result in the lookup. If you

type 'black' in the Item numberItem number  field, you will get the second product as a result, because it has the text 'black'

in the display product number. These two examples illustrate that the search is not only at the beginning of the

field, a match will occur even if the search text is found in the middle of a text string in the matching record.

If you type '05' you will only get the second product variant as a result, because it has '05' in the configuration.

This illustrates that the search is across all the enabled fields on the Search cr iter iaSearch cr iter ia page.

If you type 'speak 05' you will not get any results. This is because the search looks for the full text that is entered.

The search will not try to find 'speak' and then narrow the results to those containing '05'.

You can limit the number of search results by using the Number of resultsNumber of results  field on the Sales and marketingSales and marketing

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/search-products-product-variants.md


Configure the product search

Step 1: Include all the relevant product and product variant identifiers and dimensions in the search criteriaStep 1: Include all the relevant product and product variant identifiers and dimensions in the search criteria

Step 2: Populate the database table that is used for product searchStep 2: Populate the database table that is used for product search

Step 3: Enable the lookup for product search on sales and purchase order linesStep 3: Enable the lookup for product search on sales and purchase order lines

> Setup > Search > Search parameters> Setup > Search > Search parameters  page. If you set this field to 0, all search results will be returned. If

you set it to 10, for example, it will return a maximum 10 search results.

Before you can use the product and product variant search feature, follow these steps to configure the product

search. 

Examples of product and product variant identifiers and dimensions that you can search by are Product name,Product name,

Item numberItem number , Display product number, Configuration, Color, S ize, Style, Search name, etcDisplay product number, Configuration, Color, S ize, Style, Search name, etc.

Go to Sales and marketing > Setup > Search > Search cr iter iaSales and marketing > Setup > Search > Search cr iter ia page. The Search cr iter iaSearch cr iter ia page allows

you to define criteria for customer, prospect, and product search. Make sure you filter the page by using product

search criteria. You can do this by switching to ProductProduct in the page's menu.

To add the display product number to the search criteria, click NewNew  in the page's menu. This will add a new

record in the Search cr iter iaSearch cr iter ia grid. Open the Field nameField name column lookup and chose DisplayProductNumberDisplayProductNumber .

To add the product's configuration to the search criteria, create a new record in the Search cr iter iaSearch cr iter ia grid and

chose configIdconfigId in the Field nameField name column. In the same manner, create a record with Field nameField name

InventColorIdInventColorId for the color dimension, InventSizeIdInventSizeId for the size dimension, and InventStyleIdInventStyleId for the style

dimension.

In the Search cr iter iaSearch cr iter ia page, click the Update search dataUpdate search data button. In the Update search dataUpdate search data dialog box,

make sure that SourceSource is set to ProductProduct, and then click OKOK. The system will aggregate in one table all the

selected search criteria specified in step 1. If you have a lot of products and product variants, this operation can

be quite lengthy and you may receive a warning. We recommend that you schedule the search table population

on the batch server at a time when the server is not too busy.

Until the table is populated, product search will not provide the correct results. If you do not get any search

results, make sure that this table is populated.

The table only has to be populated when the search criteria is modified. Newly released products and variants

are automatically added to the table. Deleted products and variants are automatically removed from the table.

You can enable this functionality by going to Sales and marketing > Setup > Search > SearchSales and marketing > Setup > Search > Search

parametersparameters  and setting Enable lookup for searchEnable lookup for search to YesYes  on the GeneralGeneral  tab.

For sales order line entry, the default behavior is to open the Product searchProduct search page when you start typing in

the Item numberItem number  field, and then press the TabTab key. The Product searchProduct search page changes the context during

order line creation and may be considered unnecessarily intrusive. If you prefer to get the search results in a

lookup and not lose context during order line entry, you can use the search lookup instead. If you search for a

product or product variant, but you don't select anything in the lookup and press the TabTab key, the ProductProduct

searchsearch page will display.

file:///T:/eiye/ac1a/dynamics365/supply-chain/pim/media/3-steps-to-configure-product-search_axappfall.png
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Default order settings

NOTENOTE

Default order settings in Dynamics 365 Supply Chain Management define the site and warehouse where items

will be sourced from or stored, the minimum, maximum, multiple and standard quantities that will be used for

trading or inventory management, the lead times, the stop flag, and the order promising method. Default order

settings are used when creating purchase orders, sales orders, transfer orders, inventory journals, and by master

planning for generating planned orders. Default order settings can be item specific, site specific, product variant

specific, or product dimension specific.

To define the default order settings for a product, follow these steps.

1. Go to Product information managementProduct information management > ProductsProducts  > Released productsReleased products .

2. Select the relevant product in the grid.

3. On the Action Pane, follow one of these steps to open the Default order settingsDefault order settings  page for the selected

product:

On the PlanPlan tab, in the Order settingsOrder settings  group, select Default order settingsDefault order settings .

On the Manage inventor yManage inventor y  tab, in the Order settingsOrder settings  group, select Default order settingsDefault order settings .

4. Configure the settings as described in the rest of this topic.

There are three types of default order settings for purchases, sales, and inventory. The default order settings for

purchases are used when creating:

Purchase order lines

Purchase agreement lines

Request for quotation lines

Purchase requisition lines

Consignment replenishment lines (partially supported, see note)

Planned purchase orders

For consignment replenishment order lines, the only settings from the Purchase orderPurchase order  FastTab of the Default orderDefault order

settingssettings page that apply are the Default siteDefault site field, Default warehouseDefault warehouse field, and StoppedStopped check box.

The default order settings for sales are used when creating:

Sales order lines

Sales agreement lines

Sales quotation lines

Return order lines and item replacement lines

Demand forecast lines

The default sales order settings also apply when creating:

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/default-order-settings.md


Full definition of a released product

Default order settings rules

Rank in default order settingsRank in default order settings

Project item requirements

Service order item requirements

The default order settings for inventory are used when creating:

Inventory journals

Transfer orders

Planned transfer orders

The default inventory order settings also apply when creating:

Quarantine orders

Quality orders

Production orders

BOM lines

Planned production orders

When you create a transaction, you must specify the full definition of a released product on the line, so that

Supply Chain Management can try to identify the default order settings. In the full definition of a released

product, the item number and all the active product dimensions, such as configuration, size, style, version, and

color, are specified on the transaction. For example, if you manually create a purchase order line for a released

product variant, you must specify all the required product dimensions before the site, warehouse, quantities, and

lead time will appear by default on the order line.

Not all of the default order settings parameters are applied when creating order or journal lines. Quantities and

lead times will only display by default when appropriate. For example, when counting a journal line, only the site

and warehouse will display by default when the line is created. For this reason, no default quantity or checks on

multiple and minimums are performed when creating the line or posting the journal.

The system always attempts to find a default site and warehouse when an order or journal line is created. The

site is not always displayed by default from the order settings. For example, when creating a sales order or a

purchase order, the site from the order header is automatically used on the order lines. When creating a BOM

line, the site from the BOM header is used. After the site is determined, it will be used to find any site-specific

order settings that can then be used as the default for the warehouse.

The default order type, the purchase, and the inventory lead times can be overridden by the item's coverage

rules on the Item coverageItem coverage page. Although the default order settings don't allow for the distinction between

the production and transfer lead time, the item coverage rules allow for it. However, the item coverage setup will

only be used by Master planning (MRP) when creating planned production and planned transfer orders and will

not apply when manually creating production and transfer orders.

You can define general default order settings and any number of default order setting rules that apply only in

certain conditions, such as site or a specific product dimension or product dimensions combination. You can't

define warehouse-specific order settings.

The default order settings rules have ranks. The higher the rank, the more important the rule is, meaning that it

will have a higher priority and be used before the rules with lower ranks. The general default order settings have

rank zero, which can't be modified. There can only be one rule with rank zero. Rules can have the same rank,

provided that the dimensions they apply to differ. This is useful for modeling site-specific order settings. When a

new default order settings rule is created, the values for order values, stop flag, etc. are inherited from the rule



Default order settings for released productsDefault order settings for released products

Site-specific order settingsSite-specific order settings

Specific order settings for product dimensionSpecific order settings for product dimension

Product nameProduct name Photoelectric sensor

Item numberItem number XW56

ConfigurationConfiguration (used to model the type of light) C1-Visible red light, C2-Infrared light

VersionVersion V1, V2, V3
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with rank zero, but can be overridden.

For distinct released products, you can define general order settings or site-specific order settings. The general

order settings will always have rank zero. If you set up new sales, purchase, and inventory order settings at the

same time, we recommend that you use the Details viewDetails view  on the Default order settingsDefault order settings  page. To switch to

the details view, go to OptionsOptions  > Page optionsPage options  > Change viewChange view  > Details viewDetails view .

To create site-specific order settings, select NewNew . In Details viewDetails view , enter the site in the S iteSite field in the SettingsSettings

applicable forapplicable for  section. In Grid viewGrid view , enter the site in the S iteSite column. The new rule is automatically assigned a

new rank value that is more than 0 (zero). You can create as many site-specific rules as you require. To indicate

that they are equally important, you can assign the same rank value to all the site-specific rules.

If you are in Details viewDetails view , you can't get the overview of the rules created for the item. Use the Show/Hide listShow/Hide list

button to see overview information. When an order line of any type is created and it has no site provided,

Supply Chain Management searches for a rule with no site specified. This helps to determine a default site on

the order line. This site is then used to search for a site-specific rule, where a default warehouse may have been

set. This warehouse is applied to the order line.

You can define order settings rules for any active product dimension or combination of active product

dimensions. If a product dimension field is empty, then that the rule applies to all values of the product

dimension.

Consider the following example product.

For this example, assume that the product is procured and not produced. Also assume that configuration C1 is

more commonly used, so it has shorter lead times.

Create the following default order settings to model this scenario.

When a purchase order line or a planned purchase order is created for item XW56, configuration C1, regardless

of the version or site where the line is put, the lead time will be considered 2. Assume that all versions besides

V3 are stopped.

You can create the following default order settings rules.
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The two rules for stopping the old versions have the same rank. Therefore, they are equally important. Because

both these rules have a higher rank than the rule for configuration C1, they take precedence over the rule for

configuration C1.

This example explains the need for the rank. If the rank isn't used, when a purchase order is created for

configuration C1 and version V2, the two rules that are defined for V2 and C1 will be ambiguous. To solve the

ambiguity, Supply Chain Management will search through the rules in descending order of rank and apply the

first applicable rule. In the current example, when a purchase order line is created for configuration C1 and

version V2, the user will receive a warning message that states that the item is on hold, and that this hold is

caused by the version value. If the rule for the configuration had a higher rank than the rule for the version, a

purchase order line would be successfully created for configuration C1 and version V2, and the user would

receive no "item on hold" message.

Consider the following default order setting rules.

The system traverses the set of rules two times to determine the site and warehouse. When a purchase order

line is created for configuration C1, version V2, the site is determined based on the rule that has a rank of 10.

The system then searches for a rule for site 2 to determine a warehouse. Rule 20 is found, and because it has a

higher rank, the warehouse on the purchase order line will be 22, not 21.

As general guidance, specific rules and rules for dimensions that are more important than other dimensions get

higher ranks, while more generic rules get lower ranks.

The rule with rank zero serves as a safety net. If no other rules are hit, then the default order settings from rule

zero will be used.

Because the rank number is important, on the Default order settingsDefault order settings  Action Pane, there are functions to move

a rule up or down and to renumber the rules, so that they are always in increments of 10.

The number of rules created for a released product may be many. In order to get a better understanding of what

each rule is overriding and why it's needed, we recommend using the Grid viewGrid view  on the Default orderDefault order



Specific order settings for released product variantSpecific order settings for released product variant
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Use strict or standard validation of default order quantities

Enable the strict validation optionEnable the strict validation option

Set the validation optionSet the validation option

settingssettings  page. You can enable the grid view by going to OptionsOptions  > Page optionsPage options  > Change viewChange view  > GridGrid

viewview . The number of columns displayed in the grid could be quite significant, especially for the sales and

inventory tabs. To limit the number of columns shown in the grid, groups of columns can be hidden or displayed

by using the buttons on the Default order settingsDefault order settings  > Column displayColumn display  menu.

If the rule system for default order settings is too cumbersome, then there is the option to define default order

settings for each product variant. The following example shows how this will look for the product and the cases

described above.

The rank in this case doesn't really matter, so you can choose to hide it. This solution potentially introduces a

maintenance issue. However, you may want to consider using this setup if you are considering integrating with

Product Lifecycle Management (PLM) systems.

You can choose how strict the system should be when validating quantities entered in the Default orderDefault order

settingssettings  for a product. When you use the new strict option, the Standard order quantityStandard order quantity  must always be a

multiple of the specified MultipleMultiple value for purchase orders, inventory, and sales orders. If you are using strict

validation, you won't be able to save default order settings that don't meet this requirement (and an error is

shown in the message bar).

Strict validation applies to Standard order quantityStandard order quantity  values specified on the Purchase orderPurchase order , Inventor yInventor y , and

Sales orderSales order  FastTabs of the Default order settingsDefault order settings  page. Each FastTab has its own MultipleMultiple setting, which is

used to validate the Standard order quantityStandard order quantity  value specified for that FastTab.

Before you can use the strict validation option, it must be enabled on your system. Administrators can use the

Feature management page to check the feature status and enable it if needed. Here, the feature is listed as:

ModuleModule - Product information management

Feature nameFeature name - Strict validation on default order quantities

To set the validation option:



NOTENOTE

1. Go to Product information management > Setup > Product information managementProduct information management > Setup > Product information management

parametersparameters .

2. On the GeneralGeneral  tab, set Validation on default order quantitiesValidation on default order quantities  to one of the following values:

Str ictStr ict - Select this option to ensure that all Standard order quantityStandard order quantity  values will be a multiple of the

MultipleMultiple value for each FastTab (Purchase orderPurchase order , Inventor yInventor y , and Sales orderSales order ).

StandardStandard - Select this option to use standard validation (which works the same as when this feature

isn't enabled).

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Bills of materials

Formulas, co-products, and by-productsFormulas, co-products, and by-products

BOMs in the product lifecycleBOMs in the product lifecycle

This topic provides information about bills of materials (BOMs) and formulas, which are a central part of the

definition of products and product variants. BOMs and formulas specify the required materials or ingredients for

a specific product. Formulas also specify the co-products and by-products that are received in a specific

production context.

A bill of materials (BOM) defines the components that are required in order to produce a product. The

components can be raw materials, semi-finished products, or ingredients. In some cases, services can be

referenced in a BOM. However, BOMs typically describe the material resources that are required.

When it's combined with a route or production flow that describes the operations and resources that are

required in order to build a product, the BOM forms the foundation for calculating the estimated cost of the

product.

A BOM is an individual entity that is described by the following information:

BOM ID

BOM name

The BOM lines that describe the components and ingredients

The BOM versions, which define the product and period that the BOM can be used for

A single BOM describes a single level that is identified by a unique ID. Components might have their own BOMs

that are referenced by BOM versions. You can display and edit the complete hierarchy of BOMs for a specific

product in the BOM designer.

A formula is a subtype of BOM that is typically used for process manufacturing. In addition to components and

ingredients, a formula describes co-products and by-products. In the actual version, the definition of co-

products and by-products for the formula requires the formula version. A formula is typically defined for one

specific finished product (a formula or planning item) that is defined in the formula version.

In the product lifecycle, many types of BOM might be created for various reasons:

Sketching/Draft BOMSketching/Draft BOM – This BOM gives a draft estimation of required materials in an early design phase

and helps you do a rough estimate of cost and estimated product attributes. This BOM isn't usually used in

enterprise resource planning (ERP).

Engineering BOMEngineering BOM – This BOM is typically used when you design products that are based on existing

product portfolios. Engineering BOMs are structured to simplify the design process and group complex

products into engineering modules. For simple products, it might be possible to engineering BOMs for the

actual production process. However, for other products, the engineering BOM must be converted to an actual

production BOM. Engineering BOMS are typically represented by phantoms in the BOM hierarchy. Although

engineering BOMs can be used for the planning and execution of manufacturing operations, this approach

can lead to inefficiencies, especially in repetitive operations where many orders are created.

Planning BOMPlanning BOM – This BOM is used to do planning for material requirements. The demand of components

and ingredients is calculated based on the demand of the finished products. Like costing BOMs, planning

BOMs might represent a specific mix of material that is used in a period.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/bill-of-material-bom.md


Approval of BOMs and formulasApproval of BOMs and formulas

BOM and formula versions

Approval of BOM and formula versionsApproval of BOM and formula versions

Activation of the default BOM or formula versionActivation of the default BOM or formula version

Product change with case managementProduct change with case management

Alternative BOM versionsAlternative BOM versions

Production BOMProduction BOM – This is the actual BOM that is used for a specific production. A production BOM must

take into account the actual resources that are used to produce the product. When a production order, batch

order, or kanban is created, the multiple levels of BOMs that are represented by phantoms are collapsed into

one level and distributed over the operations for the order.

Costing BOMCosting BOM – This BOM is used to calculate the estimated cost of a product. For example, you can use a

costing BOM when standard cost is used or the estimated planned cost of a given product is calculated.

Costing BOMs can refer to a specific mix of materials and resources that is expected to be used. Therefore,

you can use the costing BOM to create a representative estimated cost for a period and help avoid variances

over time.

The types of BOM that are actually used in an implementation depend on the implementation, and also on the

business scenarios and requirements. In simple implementations, a planning BOM, production BOM, and costing

BOM can be modeled as one BOM. In environments that have frequent engineering changes and multiple

alternative routes, a larger set of BOM types will probably be required.

Each BOM and formula can be separately approved or unapproved. Typically, approval of a BOM or formula

occurs when the first relevant BOM version is approved. However, in some business scenarios, these approvals

might be different steps in the process and might involve different process owners.

Note that, if a BOM is unapproved, all related BOM versions are also unapproved.

To relate a specific BOM or formula to a product variant that can be produced, you must create a BOM version or

formula version. The validity of BOM versions and formula versions can be constrained by period, quantity, site,

specific product dimensions, and other criteria. Formula versions have additional important attributes, such as

yield, co-product and by-product definitions, and the cost distribution instructions for the formula.

Before a BOM version can be used in the planning or manufacturing process, it must be approved. When a BOM

version is approved, the related BOM can also be approved, depending on the user's selection and

authentication rights. Note that a BOM version can be approved only if the related BOM itself is approved.

To set a specific BOM or formula as the default BOM version or formula version that will be used by master

planning or used to create of production orders, you must activate the version. When a version is activated, the

uniqueness of the version for the given constraints (for example, period, site, or quantity) is verified. You receive

an error message if the version that you're trying to activate conflicts with a version that is already active. You

must then either inactivate the conflicting version or modify the version constraints (usually the period) to

prevent an ambiguous activation.

The product change case for approval and activation of new or changed BOMs and BOM versions provides an

easy way to see an overview of the BOM version constraints. You can also approve and activate all BOMs and

formulas that are related to a specific change for one activation date.

Sometimes, the active BOM version or formula version should not be used in forecasts, sales, or a parent

product. In this case, you can select a specific approved BOM as part of the requirement (forecast line, sales line,

or BOM line) if an approved BOM version or formula version exists for the alternative BOM or formula.

When planned orders, production orders, or kanbans are created, the planner or shop floor supervisor can use

any approved BOM version that is valid on the requested planned production date to plan for or produce a



BOM and formula lines

ItemItem

PhantomPhantom

Pegged supplyPegged supply

VendorVendor

NOTENOTE

specific product. The BOM version that is used doesn't have to be activated as the default BOM version.

A BOM line is created for each material, service, or ingredient. The line defines the planned consumption of the

specified product variant and also defines the various attributes that are related to the planned consumption.

BOM lines can have the following line types: ItemItem, PhantomPhantom, Pegged supplyPegged supply , VendorVendor .

Select the ItemItem line type for materials or services that are directly consumed, and that don't require further

explosion or pegged supply.

Select the PhantomPhantom line type when you want to explode any lower-level BOM items that are contained on the

BOM line. In Master scheduling, in planned cost calculation, or on estimation of a production order that uses

BOM lines of the PhantomPhantom type, the parent BOM line that refers to a product variant that has a phantom BOM

is replaced by the component items that are listed as BOM lines in that BOM, as determined by the applicable

active BOM version of that product variant. If the product variant has an applicable active route, the operations

of that route are merged into the parent route.

Note that phantoms are typically used to simplify the engineering process. Extensive use of phantom BOMs in

many levels has an effect on performance, especially in highly repetitive manufacturing scenarios. To improve

performance, you should avoid deep hierarchies of phantoms. Instead, use pre-exploded production BOMs and

routes.

Select the Pegged supplyPegged supply  line type when you want to create a subproduction, a BOM line event kanban, or a

direct purchase order for any product variant that the BOM line references. The subproduction, event kanban, or

purchase order is created when you estimate the production order. The required item quantities are

automatically reserved for the consuming production order.

Select the VendorVendor  line type if the production process uses a subcontractor, and you want a subproduction or

purchase order to be created automatically for the subcontractor.

Note about subcontracted operations in a BOM:Note about subcontracted operations in a BOM: The service or work that is performed by the

subcontractor must be created as service item that is tracked in inventory. You must attach the service item to

the parent item as a BOM line. The route must contain an operation that is assigned to the subcontractor's

operations resource.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Analyzing a BOM structure by using the BOM designer

Selecting a BOM and route
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Product dimensions If the selected finished product is a product master, you can
define the active product dimensions for the main selection.
Note:Note:  If you open the BOM designer for a product that isn't
a product master, no product dimensions can be selected in
the FilterFilter  dialog box.

This topic describes how you can use the BOM designer page to design and work with tree structures for bills of

materials (BOMs). You can click Setup to select different configurations and specify what information appears on

the lines of the tree.

When you open the BOM designerBOM designer  page from the Released productsReleased products  page, it displays the hierarchy of bills

of materials (BOMs) that are active and approved for the selected item, the default order site of the item, and the

actual date.

Click FilterFilter  to change the initial selection in the view. By setting the display principle to Selected/Active orSelected/Active or

SelectedSelected, you can select individual BOM or route versions to use in the view. You can select non-approved and

non-active BOM versions to show or maintain in the BOM designer.

Note:Note: If you open the BOM designer from the Bills of mater ialsBills of mater ials  list page, it doesn't display route information.

Currently, the selection of a BOM or route version is a property of the BOM and route version, and applies to all

instances of the BOM designer.

The following sections describe the functionality that is available on the various tabs of the BOM designer.

The BOM designer has two sections:

The tree view of the BOM structure.

The details section, which shows details of the selected data. When you select a node in the tree view, the

FastTabs in the details section are updated based on that node:

BOM line detailsBOM line details  – Shows the details of the BOM line that is selected in the tree view.

Item dataItem data – Shows the details of the main item or the item that is used in the selected node. You can

click Edit released productEdit released product to maintain the selected item.

BOMBOM – Shows the header of the BOM that is related to the selected node.

RouteRoute – Shows the header of the route that is related to the selected node.

Route operationsRoute operations  – Shows a preview of the operations for the route. When a BOM line that is

assigned to a specific operation is selected, the operation is marked as Component needed atComponent needed at

operationsoperations .

The filter that is applied for the BOM and route is displayed in the header of the BOM designer. You can change

the filter by using the FilterFilter  dialog box. The following table describes the fields in this dialog box.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/bom-designer-functionality.md


Site Change the site that the BOM tree is displayed for. The
default site is the default inventory site of the finished item.

Display principle Select the version display principle that applies to the current
BOM structure and the current route:

Version date Enter the version date for the BOM and route. The version
identifies which BOM version is used on a specific date, as
determined by the version dates in the BOM version setup.

From quantity Filter the versions by selecting a specific from quantity. If you
set a value, different BOM and route versions might be
selected.

Show valid only When you select the check box, the tree structure shows
only BOM lines that have valid dates. Right-click or double-
click a BOM line to open the Edit BOM lineEdit BOM line page, where
you can see the validity dates for that BOM line.
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Adding and editing BOMs and BOM lines
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BOM lines > Edit Open a dialog box where you can edit
the BOM line attributes.

This function is available when a BOM
line node is selected.

BOM lines > Delete Delete a BOM line from the selected
BOM.

This function is available when a BOM
line node is selected, and the BOM
isn't locked for editing.

BOM lines > Add before line Open a dialog box where you can
select a product variant to include
before the selected BOM line.

This function is available when a BOM
line node is selected.

When the principle is set to Active orActive or
Selected/ActiveSelected/Active, the valid BOM or route version for
this date is found.

When the principle is set to Selected/Active orSelected/Active or
SelectedSelected, you can select a BOM version or route
version by clicking BOMBOM > BOM versionsBOM versions or RouteRoute
> Route versionsRoute versions .

When you use the BOM designer to review or edit BOMs that consist of one or more levels of phantoms, the

route that is associated with the top item typically spans the complete BOM hierarchy. To simplify the overview,

you can lock the top-level route in the display by clicking ViewView  > Lock routeLock route. To unlock the route, click ViewView  >

Unlock routeUnlock route.

Use the BOM linesBOM lines  or BOMBOM functions to modify the BOM lines or BOM. When you select a node in the tree, the

type of the node determines that functions that are available.



BOM lines > Add to component BOM Open a dialog box where you can
select a product variant to include at
the end of the selected BOM.

This function is available when the
node that is selected has a selected
BOM. If this function isn't available, a
BOM version might be missing for the
selected item variant. In this case, you
can click BOMBOM > Create versionCreate version to
create the missing version for the
selected node.

BOM lines > Add after line Open a dialog box where you can
select a product variant to include after
the selected BOM line.

This function is available when a BOM
line node is selected.

BOM > Create version Create a new BOM version or BOM for
the product variant of the selected
node.

This function is available when the
BOM line node that is selected is
linked to an item that has a production
type of BOMBOM or FormulaFormula.

BOM > Calculation Open a dialog box where you can run
the cost or sales price calculation for
the selected product variant.

This function is available when the
node that is selected is related to a
BOM version.

BOM > Check Validate and check the selected BOM. This function is available when the
node that is selected is related to a
BOM version.
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Configuring the tree view
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BOM Use the check boxes to select the criteria that are shown in
the tree structure. The BOM designer displays the selected
criteria at the bottom of both tabs.

Route Use the check boxes to select the criteria that are shown for
the routes.

NOTENOTE

Click SetupSetup to customize the information that is shown in the tree view of the BOM designer.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Formula designer
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NOTENOTE

Analyze a formula structure by using the formula designer

Select a formula and route
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This topic explains how to use the formula designer to analyze and maintain formulas in a tree view.

When you open the Formula designerFormula designer  page from the Released productsReleased products  page, the tree in the left pane

shows the list of co-products and the hierarchy of ingredients for the released product. The structure is derived

from the hierarchy of formulas that are active and approved for the selected item and its ingredients, the default

order site of the item, and the actual date.

Click SetupSetup to select different configurations and specify what information appears on the lines of the tree.

Click FilterFilter  to change the initial selection in the view. If you set the display principle to Selected/ActiveSelected/Active or

SelectedSelected, you can select individual formula or route versions to use in the view. You can select non-approved

and non-active formula versions to show or maintain in the formula designer.

If you open the Formula designerFormula designer  page from the Bills of materialsBills of materials  list page, it doesn't show route information.

Currently, the selection of a formula or route version applies to all instances of the formula designer.

The following sections describe the functionality that is available in the BOM designer.

The formula designer has two sections:

The tree view of the formula structure.

The details section, which shows details of the selected data. When you select a node in the tree view, the

FastTabs in the details section are updated based on that node:

Formula line detailsFormula line details  – View the details of the formula line that is selected in the tree view.

Item dataItem data – View the details of the main item or the item that is used in the selected node. You can

click Edit released productEdit released product to maintain the selected item.

FormulaFormula – View the header of the formula that is related to the selected node.

RouteRoute – View the header of the route that is related to the selected node.

Route operationsRoute operations  – View a preview of the operations for the route. When a bill of materials (BOM)

line that is assigned to a specific operation is selected, the operation is marked as ComponentComponent

needed at operationsneeded at operations .

The filter that is applied for the formula and route is shown in the header of the formula designer. You can

change the filter by using the FilterFilter  dialog box. The following table describes the fields in this dialog box.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/formula-designer.md


Product dimensions If the selected finished product is a product master, you can
define the active product dimensions for the main selection.
Note that if you open the formula designer for a product
that isn't a product master, no product dimensions can be
selected in the FilterFilter  dialog box.

Site Change the site that the ingredient tree is shown for. The
default site is the default inventory site of the finished item.

Display principle

Version date Enter the version date for the formula and route. The version
identifies which formula version is used on a specific date,
based on the version dates in the formula version setup.

From quantity Filter the versions by selecting a specific "from" quantity. If
you set a value, different formula and route versions might
be selected.

Show valid only When you select the check box, the tree structure shows
only formula lines that have valid dates. Right-click or
double-click a formula line to open the Edit formula lineEdit formula line
page, where you can see the validity dates for that formula
line.
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Add and edit formulas and formula lines
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BOM lines > Edit Open a dialog box where you can edit
the formula line attributes.

This function is available when a
formula line node is selected.

BOM lines > Delete Delete a formula line from the selected
formula.

This function is available when a
formula line node is selected, and the
formula isn't locked for editing.

Select the version display principle that applies to the
current formula structure and the current route:

When the principle is set to ActiveActive or
Selected/ActiveSelected/Active, the valid formula or route version
for this date is found.

When the principle is set to Selected/ActiveSelected/Active or
SelectedSelected, you can select a formula version or route
version by clicking FormulaFormula > Formula versionsFormula versions or
RouteRoute > Route versionsRoute versions .

When you use the formula designer to review or edit formulas that consist of one or more levels of phantoms,

the route that is associated with the top item typically spans the complete formula hierarchy. To simplify the

overview, you can lock the top-level route in the display by clicking ViewView  > Lock routeLock route. To unlock the route,

click ViewView  > Unlock routeUnlock route.

Use the BOM linesBOM lines  or FormulaFormula functions to modify the formula lines or formula. When you select a node in

the tree, the type of the node determines the functions that are available.



BOM lines > Add before line Open a dialog box where you can
select a product variant to include
before the selected formula line.

This function is available when a
formula line node is selected.

BOM lines > Add to component BOM Open a dialog box where you can
select a product variant to include at
the end of the selected formula.

This function is available when the
node that is selected has a selected
formula. If this function isn't available,
a formula version might be missing for
the selected item variant. In this case,
you can click FormulaFormula > CreateCreate
versionversion to create the missing version
for the selected node.

BOM lines > Add after line Open a dialog box where you can
select a product variant to include after
the selected formula line.

This function is available when a
formula line node is selected.

Formula > Create version Create a new formula version or
formula for the product variant of the
selected node.

This function is available when the
formula line node that is selected is
linked to an item that has a production
type of BOMBOM or FormulaFormula.

Formula > Calculation Open a dialog box where you can run
the cost or sales price calculation for
the selected product variant.

This function is available when the
node that is selected is related to a
formula version.

Formula > Check Validate and check the selected
formula.

This function is available when the
node that is selected is related to a
formula version.
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Configuring the tree view
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BOM Use the check boxes to select the criteria that are shown in
the tree structure. The formula designer shows the selected
criteria at the bottom of both tabs.

Route Use the check boxes to select the criteria that are shown for
the routes.

NOTENOTE

Click SetupSetup to customize the information that is shown in the tree view of the formula designer.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Override the default reservation principle for
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IMPORTANTIMPORTANT

Turn on the feature

Assign a production reservation policy to an item model group

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

The Override default production reservation feature lets you set a default reservation principle for each item

model group. Therefore, different reservation principles can automatically be applied for each item that is part

of a production bill of materials (BOM) or batch order formula. You can select whether each item model group

should override the default reservation principle that is set for an order, and what reservation principle should

be used instead (manual, estimation, scheduling, release, or start).

When you create a new production order or batch order, you're prompted to select the reservation principle that

should be applied to that order and all its BOM lines or formula lines. When the Override default production

reservation feature is used, some or all of the BOM or formula lines can override that reservation principle and

instead use the reservation principle that is set for the relevant item model group.

For example, if you have raw materials or ingredients that require pick work, BOM or formula lines that are

created for those products require a physical reservation, because physical reservation is a prerequisite for the

generation of warehouse work. Typically, if you want the reservation to occur automatically, you select one of

the following reservation principles: estimation, scheduling, release, or start. On the other hand, if you have

materials or ingredients that don't require pick work, because they are consumed directly from a location, you

typically select the manual reservation principle, which doesn't make any physical reservations or generate any

pick work.

Before you can use the feature, it must be turned on in your system. Admins can use the feature management

settings to check the status of the feature and turn it on. In the Feature managementFeature management workspace, the feature is

listed in the following way:

Module:Module: Production control

Feature name:Feature name: Override default production reservation

1. Go to Cost management > Inventor y accounting policies setup > Item model groupsCost management > Inventor y accounting policies setup > Item model groups .

2. Create or select an item model group.

3. On the Inventor y policiesInventor y policies  FastTab, select the Overr ide item production reser vationOverr ide item production reser vation check box.

4. In the Reser vationReser vation field, select the reservation principle for items that belong to the selected model

group. (Those items include items that are on a BOM or formula line.)

ManualManual  – Items in the model group won't automatically be physically reserved for production.

However, they can still be manually reserved as required.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/override-default-reservation-principle.md
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Example: Using reservation principles in a bulk/pack scenario

NOTENOTE

EstimationEstimation – Items in the model group will be physically reserved during estimation of the

production order.

SchedulingScheduling – Items in the model group will be physically reserved during scheduling of the

production order.

ReleaseRelease – Items in the model group will be physically reserved when the production order is released.

Star tStar t – Items in the model group will be physically reserved at the start of the production order.

A bulk lubricant material is produced in a 1,000-liter mixer. After the bulk material is ready, it's pumped out to

several filling stations, where bottles of different sizes are filled. After filling is completed, the bottles are packed

into boxes. Those boxes are then packed onto pallets.

In this scenario, a batch order to make 1,000 liters of bulk material is created. (This order is the bulk order.)

When this batch order is completed, it's reported as finished to the material input location of the filling stations.

A batch order to fill and pack each bottle size is then created. (These orders are the pack orders.) The pack orders

have a formula that consists of the bulk material, an empty bottle, a label, and other packing materials. Because

the bulk material flows directly from the mixer tank to the filling stations, no warehouse work is required to pick

this ingredient, and the bulk material is consumed directly from the input location. Therefore, the reservation

principle is set to manual. The other materials are staged to the filling station by pick work. Therefore, the

reservation principle for these lines is set to release, for example, so that the reservation automatically occurs

when the pack order is released.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Add variant products to purchase orders using
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NOTENOTE

This procedure walks through the steps for using variant weights to auto populate purchase order lines for each

variant of a product. When you select the quantity of the product you want to purchase, purchase order lines are

created for all the variants of the product with suggested quantities based on the weights configured on the

product variants. This procedure doesn't include steps to configure weight values on product dimensions and

product variants. This procedure uses the USRT company in demo data.

1. Go to Accounts payable > Purchase orders > All purchase orders.

2. Click New.

3. In the Vendor account field, click the drop-down button to open the lookup.

4. In the list, click the link in the selected row.

5. Toggle the expansion of the General section.

6. In the Site field, click the drop-down button to open the lookup.

7. In the list, click the link in the selected row.

8. In the Warehouse field, click the drop-down button to open the lookup.

9. In the list, find and select the desired record.

10. In the list, click the link in the selected row.

11. Click OK.

12. Toggle the expansion of the Line details section.

13. Click the Variants tab.

14. Click Add line.

15. In the list, mark the selected row.

16. In the Item number field, type '0140'.

17. Set Quantity to '1000'.

18. Click Save.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a sales order for a configurable product
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Create a sales order

Select the product configuration

NOTENOTE

This procedure shows how to apply a configuration template to a product on a sales order. This example uses

the D0006 speaker model in the USMF demo data company. Typically, a sales order processor uses this

procedure.

1. Click Sales order processing and inquiry.

2. Click New.

3. Click Sales order.

4. In the Customer account field, select US-001.

5. Click OK.

6. In the Item number field, select D0006.

7. Click Product and supply.

8. Click Configure line.

9. Click Load template.

10. Click OK.

11. Click OK.

12. Expand the Line details section.

13. Click the Product tab.

14. Close the page.

For this task, you must select a configurable product.

Note that the price has changed, based on the configuration that was selected, and that the Include

cable field is now set to True.

Note the default price and the settings that are selected for the cable.

This example shows how you can apply a template to select a predefined configuration. If you're using

this procedure as a task guide and want to see the other attribute values that are available, you must

click the Unlock button.

The configuration of the item is now listed under the product dimensions.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create sales price selection criteria
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Add a new criterion for an existing sales price model

Create the query for the selection criteria

NOTENOTE

This procedure shows how to create a sales price selection criterion for attribute-based sales price models. This

procedure requires that at least one sales price model be available. This example uses the price model for the

Speaker solution sales price model in the USMF demo data company. Typically, a product manager uses this

procedure.

1. Click Product variant model definition.

2. Click Product configuration models.

3. In the list, select the row for the Speaker solution product model, but don't click the link for the model name.

4. On the Action Pane, click Model.

5. Click Price model criteria.

6. Click New.

7. In the Name field, type 'Customer group 10'.

8. In the Price model field, enter or select a value.

9. In the Order type field, select Sales order.

10. In the Valid from field, enter a date.

11. In the Expire by field, enter a date.

12. Click Save.

The name of the price model criterion is used to help identify the underlying selection criteria.

The order type determines the database fields that will be available for the selection query.

1. Click Edit.

2. In the Table field, select Customers.

3. In the Field field, select Customer group.

4. In the Criteria field, select Customer group 10.

5. Click OK.

In this example, we will use a specific customer group for the selection criteria.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Set up attribute-based pricing for configurable
products
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Create a new price model

Add price elements

NOTENOTE

This topic explains how to set up attribute-based pricing. As a prerequisite, you must have a product

configuration model that has one or more components and attributes. This example uses the High End Speaker

product model in the USMF demo data company. Typically, a product manager uses this procedure.

1. Select Product var iant model definitionProduct var iant model definition on the home page.

2. Select Product configuration modelsProduct configuration models  in the linkslinks  section.

3. In the list, select the High End SpeakerHigh End Speaker  line, but don't select the link for the name.

4. On the Action Pane, select ModelModel .

5. Select Pr ice modelsPr ice models .

6. Select NewNew .

7. In the Pr ice model namePrice model name field, type a value. Use a name that makes the model easy to identify.

8. In the Descr iptionDescr iption field, type a value.

9. Select SaveSave.

1. Select EditEdit. Each component in a product model can have a base price element and any number of price

expression rules. You can also add prices in different currencies.

2. In the Base pr ice expressionBase pr ice expression field, type a value. For example, type 100. A base price expression can be a

numerical value, or it can consist of an arithmetic calculation that involves one or more attributes.

3. Select AddAdd.

4. In the NameName field, type Rosewood . The price expression name helps identify what the price element

represents. In this example, we are creating a price element for the Rosewood speaker cabinet finish option.

5. Select Edit conditionEdit condition. A price condition helps guarantee that a price expression element is included in the

sales price only if a specific combination of attributes is present.

6. In the ConstraintBodyConstraintBody  field, enter CabinetFinish=="Rosewood" .

7. Select OKOK.

8. In the ExpressionExpression field, type a value. For example, type 50 .

9. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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The cost roll-up and sales price calculations are known as bill of materials (BOM) calculations, and you initiate

them from the Calculations page. This topic provides information about BOM calculations.

The cost roll-up and sales price calculations are known as bill of materials (BOM) calculations, and you initiate

them from the CalculationsCalculations  page. You use the CalculationsCalculations  page to perform the following tasks:

Calculate the cost of a manufactured item, and generate an associated item cost record within a costing

version.

Calculate the sales price of a manufactured item, and generate an associated item sales price record within a

costing version.

The way that you use the CalculationsCalculations  page varies slightly, depending on how you initiate the BOM

calculations. The way that you use the CalculationsCalculations  page also depends on whether the BOM calculations

involve a costing version for standard costs or planned costs, and on several policies that are defined in the

costing version that is used in the BOM calculations. Note:Note: A variation of the CalculationsCalculations  page is used in the

context of a sales order, sales quotation, or service order line item. These calculations are known as order-

specific BOM calculations. An order-specific BOM calculation doesn't generate an item cost record within a

costing version. Instead, it generates a calculation record that appears on the BOM calculation detailsBOM calculation details  page.

The calculation record includes a calculated cost and a calculated sales price. The CalculationsCalculations  page can be

opened for a single manufactured item or for a costing version:

To calculate costs for a single manufactured item, you initiate BOM calculations from the Item priceItem price page.

The CalculationsCalculations  page inherits the item identifier. The costing version, BOM version, route version,

calculation quantity, calculation date, and site must be specified.

To calculate costs for all manufactured items or selected items, or to update items on a where-used basis, you

initiate BOM calculations from the Costing version setupCosting version setup page or the Costing version maintenanceCosting version maintenance

page. The CalculationsCalculations  page inherits the costing version.

By default, the BOM version and route version are set to the active versions for the item, site, date, and

calculation quantity. However, you can override the default values with approved versions.

By default, the calculation quantity is set to the item's standard order quantity. However, you can

override the default value.

The calculation date or site can be mandated by the costing version, or user-specified values can be set

when the date or site isn't mandated in the costing version. A future calculation date determines how

pending cost records are used. BOM calculations use a pending cost record that has the nearest from-

date that is on or before the calculation date.

For the calculations, it's assumed that the active BOM version and route version are used for a

manufactured item (and for the related site, date, and quantity), unless a manufactured component

has a specified sub-BOM or subroute.

For the calculations, it's assumed that the standard order quantity is used for manufactured items. The

standard order quantity provides the basis for calculating component quantities, determining the

relevant BOM versions and route versions (when you use quantity-sensitive BOMs and routes), and

amortizing constant costs. However, when a manufactured component has a BOM line type of

ProductionProduction or VendorVendor , or when you use a make-to-order explosion mode for the BOM calculations,

this assumption doesn't apply, because quantities reflect the specified calculation quantity.

The calculation date or site can be mandated by the costing version, or user-specified values can be set

when the date or site isn't mandated in the costing version.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/bom-calculations.md


BOM calculations that use standard costsBOM calculations that use standard costs

BOM calculations that use planned costsBOM calculations that use planned costs

Other variations in BOM calculations reflect the costing type and restrictions of the costing version:

BOM calculations that use standard costs must be restricted by costing version policies, because the

restrictions help guarantee that standard costing principles are used. Standard costing principles require the

enforcement of restrictions about the use of standard costs for purchased items, a single-level explosion

mode, and the inclusion of miscellaneous charges in unit costs.

BOM calculations that use planned costs don't have to follow standard costing principles. These BOM

calculations can use different explosion modes, alternative sources of cost data for purchased items, and

optional enforcement of restrictions within the costing version.

Policies within the costing version (for standard costs) can mandate enforcement of five BOM calculation

policies. The Recording restr ictionRecording restr iction option in the costing version mandates one of these policies, where

miscellaneous charges must be included in the unit price. Miscellaneous charges for purchased items can be

entered manually, whereas miscellaneous charges for manufactured items reflect the calculated amortization of

constant costs. The Calculation restr ictionCalculation restr iction option in the costing version mandates the other four BOM

calculation policies:

The source of cost contributions for purchased items must be based on standard costs. In other words, BOM

calculations must use the item cost records within the specified costing version, or within the fallback that

contains standard costs.

To help guarantee accurate and consistent calculation of standard costs, the explosion mode must be single-

level.

To help guarantee consistent results when the sales price of the items is calculated, the profit setting must be

mandated. The profit setting can be used, and the item sales price records can be generated, only if the

costing version allows for content of sales prices.

The fallback principle must be mandated, and can be set to NoneNone, ActiveActive (for active cost records), or

Costing versionCosting version (for a specified costing version).

Policies within the costing version (for planned costs) can optionally mandate enforcement of five BOM

calculation policies. Alternatively, the policies can just provide default values. The Recording restr ictionRecording restr iction option

in the costing version determines whether the BOM calculation policy about miscellaneous charges will be

mandated or act as a default value. Miscellaneous charges can optionally be included in the unit price. The

Calculation restr ictionCalculation restr iction option in the costing version determines whether the other four BOM calculation

policies will be mandated or act as default values:

The source of cost contributions for a purchased item can be the item cost records within a costing version.

Alternatively, the source can be defined by the BOM calculation group that is assigned to the item. For

example, the BOM calculation group can define purchase price trade agreements as the source of cost

contribution data.

The explosion mode can be single-level, multilevel, or make-to-order, or it can be based on the BOM line

item. The explosion mode for the BOM line type replicates the cost calculation logic for production order

estimates.

The profit setting can be mandated, or it can be a default value. The profit setting can be used, and the item

sales price records can be generated, only if the costing version allows for content of sales prices.

The fallback principle can be mandated, or it can be a default value. The fallback principle can be set to NoneNone,

ActiveActive (for active cost records), or Costing versionCosting version (for a specified costing version).

BOM calculations generate warning messages and other types of messages. Several BOM calculation policies

determine the types of messages. The warning conditions are defined in the BOM calculation group that is

assigned to items. However, you can override these warning conditions when you initiate a BOM calculation.

When the fallback principle is used, it's often helpful if the fallback is shown as an information message. When



BOM calculations that use the fallback principle

BOM calculation of a suggested sales price

Order-specific BOM calculations

you're trying to update calculated costs for items that have missing cost records, it's also helpful if the

information message identifies items that weren't updated.

The following situations illustrate two uses of the fallback principle:

Two-version approach to standard cost updatesTwo-version approach to standard cost updates  - A costing version can contain the incremental

changes to standard costs, such as pending cost records that represent new items or cost changes. In this

situation, the fallback principle can identify the use of the active standard costs that are contained in other

costing versions.

S imulation of the effect of cost changes by using planned costsS imulation of the effect of cost changes by using planned costs  - A costing version for planned costs

can contain incremental changes for simulation purposes. This costing version will include pending cost

records that represent the simulated cost changes to items, cost categories, and calculation formulas for

indirect cost. In this situation, the fallback principle can identify the use of the active standard costs that are

contained in other costing versions.

When you use a cost-plus-markup approach, the calculated sales price for an item reflects the set of profit-

setting percentages that is specified for the BOM calculation, and the costs that are associated with the item's

component items, routing operations, and applicable manufacturing overheads. The markup reflects profit-

setting percentages that are assigned to cost groups, and the cost groups that are assigned to items, cost

categories for routing operations, and the indirect cost calculation formulas for manufacturing overheads. The

sets of profit-setting percentages are labeled StandardStandard, Profit 1Profit 1 , Profit 2Profit 2 , and Profit 3Profit 3 . Within the Profit 1 set,

for example, a profit-setting percentage of 50 percent can be defined for a cost group that is assigned to

purchased material, and a profit-setting percentage of 80 percent can be defined for a cost group that is

assigned to cost categories for routing operations. The context of the BOM calculation determines how the

results of a calculated sales price are handled:

BOM calculation for an item and specified costing versionBOM calculation for an item and specified costing version - The BOM calculation generates a

pending sales price record within the costing version. This sales price record provides the starting point for

viewing the calculation details (for example, on the Calculate item costCalculate item cost page). The sales price record acts

mainly as reference information and isn't used as the basis for a sales price on sales orders.

Order-specific BOM calculationOrder-specific BOM calculation - A variation of the BOM calculatioBOM calculation page is used in the context of a

sales order, sales quotation, or service order line item. An order-specific BOM calculation doesn't generate a

record in the within a costing version. Instead, it generates a calculation record that appears on the BOMBOM

calculation resultscalculation results  page. This calculation record provides the starting point for viewing the calculation

details (for example, on the Calculate item costCalculate item cost page). Information about a selected calculation record can

be transferred to the originating line item. For example, the calculated sales price can be transferred to a

sales order line item.

An order-specific BOM calculation represents a variation of a BOM calculation for a manufactured item. The

order-specific BOM calculation is performed in the context of a sales order, sales quotation, or service order line

item. An order-specific BOM calculation generates a calculation record that appears on the BOM calculationBOM calculation

resultsresults  page. The calculation record includes a calculated weight, a calculated cost that is based on active cost

records, and a calculated sales price. The calculation record that each order-specific BOM calculation for an item

generates on the BOM calculation resultsBOM calculation results  page is uniquely identified by a calculation number. The results of a

calculation record can be optionally transferred to the originating line item. An order-specific BOM calculation

differs from a BOM calculation for a manufactured item in two ways:

An order-specific BOM calculation doesn't generate an item cost record within a costing version. Therefore,
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the BOM calculation policies aren't applied when an item cost record is created, or when a cost record is

overwritten.

An order-specific BOM calculation always uses the active cost records for components, cost categories, and

indirect cost calculation formulas.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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I can't delete a released product.
Issue descriptionIssue description

Issue resolutionIssue resolution

Can I change the item number of a released product?

The default flushing principle from the product isn't being entered on
the bill of materials line.
Issue descriptionIssue description

Issue resolutionIssue resolution

The system lets me save duplicate bar codes for different items or for
the same item that has different dimensions.

This topic describes how to fix issues that you might encounter while you work with product information.

You can delete a released product and all its variants only if the released product doesn't have any related

transactions.

Follow these steps to delete a released product or product master.

1. Close all open transactions for the items.

2. Reduce the inventory to 0 (zero).

3. Perform inventory closing.

4. Delete all product variants for the product master that you want to delete.

In most cases, you can't edit item numbers for released products, because that change will cause data to become

corrupted. You can edit the item number only if you must repair data corruption that was caused by a previous

rename of the primary key of that released product, as mentioned in the list of removed or deprecated features

for Finance and Operations 10.0.0 with Platform update 24.

If you want to be able to edit item numbers for released products, vote for this idea in Ideas portal.

When you add an item to a bill of materials (BOM) line, the system doesn't use the default flushing principle

information that is set up for the item. In other words, the flushing principle from the item doesn't appear on the

BOM lineBOM line page.

If you specify a flushing principle on a BOM line, it will apply to that BOM line. However, if the flushing principle

is blank, or if it isn't set on a BOM line, the flushing principle that is set on the item will still apply to that BOM

line, even though it isn't shown on the BOM line.

The defaulting logic for other features in Microsoft Dynamics 365 Supply Chain Management doesn't usually

work in this way. However, the current behavior can't be changed. Otherwise, some existing customizations that

rely on it might be broken.

The system doesn't currently enforce unique bar codes, and the addition of this restriction would be a breaking

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/troubleshooting-productinformation.md
https://experience.dynamics.com/ideas/idea/?ideaid=660fcb15-875d-ea11-b698-0003ff68bc25


I receive the following error message when I edit item record
templates: "The warehouse location cannot be created because the
item is not stocked. To stock items, the Stocked product option on the
associated item model group must be selected."
Issue descriptionIssue description

Issue resolutionIssue resolution

Default Help text that is added in product attributes isn't entered in a
released product.

The default quantity that is entered differs when it's registered from a
BOM and when it's registered from a BOM version.
Issue descriptionIssue description

Issue resolutionIssue resolution

In the released product details, I can't change the attached images
that were uploaded from the Product document attachments data
entity.

change. In fact, Microsoft has evidence that some existing customer installations would be broken by this

change. However, we will consider a broader design change to enable this feature in the future.

This issue occurs if you follow these steps to try to create a template for an item that isn't stocked.

1. Open a released product that isn't stocked.

2. On the Action Pane, on the OptionsOptions  tab, select Record infoRecord info.

3. In the Record informationRecord information dialog box, select Company accounts templateCompany accounts template.

In this case, you receive the following error message:

The warehouse location cannot be created because the item is not stocked. To stock items, the Stocked

product option on the associated item model group must be selected.

The process of creating product templates requires extra product-specific logic. Therefore, you can't use the

generic Company accounts templateCompany accounts template button for this purpose. Instead, follow these steps.

1. Open a released product.

2. On the Action Pane, on the ProductProduct tab, in the NewNew  group, select Template > Create shared templateTemplate > Create shared template.

A description and Help text that are added in the product attributes aren't visible or entered by default in the

released products. This behavior is by design.

By default, when you add an item to a BOM, the quantity is set to 1 instead of the quantity that is defined in the

Min. order quantityMin. order quantity  field on the Default order settingsDefault order settings  page for a selected product. However, when you add

an item from a BOM version, and the item and variant are selected, the quantity that is entered by default takes

into account the minimum quantity that is set in the default order settings for the specific dimensions.

This behavior is expected. However, the fact that the logic differs in the BOM and the BOM version is a known

issue. Nevertheless, this behavior won't be changed, because a change could affect many different customer

scenarios.



Issue descriptionIssue description

Issue resolutionIssue resolution

The Microsoft Flow connector shows the following error message:
"Update not allowed for field 'ProductNumber'."
Issue descriptionIssue description

Issue resolutionIssue resolution

I can't create a released product variant in another legal entity.
Issue descriptionIssue description

Issue resolutionIssue resolution

When I release a variant in another company, I receive the following
error message: "Product variant with specified dimensions has already
been created."
Issue descriptionIssue description

This issue can occur when you attach an image to an item by using the Product document attachments data

entity. In this case, the item image is shown for the item. However, if you select Change imageChange image, nothing is

shown in the list of uploaded images. Additionally, no attachments are shown for the item.

The EcoResProductDocumentAttachmentEntity entity (Product document attachments) imports document

attachments for products but not for released products. (Released products are also known as items.) To view

the attachments for an item on the Released product detailsReleased product details  page, you must use the

EcoResReleasedProductDocumentAttachmentEntity entity (Released product document attachments) instead.

This issue occurs if you try to update the Product numberProduct number  field by using the Released products entity V2 and

Microsoft Flow.

This behavior is expected. The ability to edit the product number for a released product was removed in

Dynamics 365 Finance and Operations 10.0.0 with platform update 24 to help prevent data corruption. In

exceptional cases, where you must repair data corruption that was caused by a previous rename of the primary

key of a released product, you can ask Microsoft Support to temporarily remove this restriction.

If you try to release a product master without variants, and then create the variants in each legal entity

(company) as they are required, you won't be able to release the variants by using variant suggestions. You also

won't be able to manually create the variants.

This behavior is by design. The relations of a product master and the dimensions that the master can take are

kept at a shared level. Therefore, you can't create the available dimensions for a shared product master in the

specific legal entity where those dimensions are released and then replicate the process in each legal entity

where the dimensions are required. Instead, you must change your release process to adapt to the designed

process.

Here is the process for releasing products.

1. Create the shared product master and the dimensions that can be released to the legal entities.

2. Release the products to the legal entities either by using variant suggestions or by manually adding the

combinations that should be released.

Alternatively, you can directly create the released product.

If a product variant has already been released in a company A, and you try to release it in company B by using



Issue resolutionIssue resolution
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the NewNew  button on the Released product var iantsReleased product var iants  page, you will receive the following error message:

Product variant with specified dimensions has already been created.

The NewNew  button on the Released product var iantsReleased product var iants  page creates the variant and releases it in the company

context. If the variant has already been created, you can't use the NewNew  button to release it in another company.

To fix the issue, open the Product masterProduct master  page, and select Release productRelease product to release the existing variant in

the desired company.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Product configuration

Building a product configuration model

The need to configure products to meet special requirements is becoming the rule rather than the exception, in

both business-to-business and business-to-consumer relationships.

A manufacturer that supports configure-to-order scenarios has an opportunity to tend more carefully to

customer needs. Additionally, by stocking semi-finished goods in the form of generic components instead of

finished products, the manufacturer can reduce the capital that is tied to inventory.

A successful move from a manufacture-to-stock setup to a configure-to-order setup requires careful analysis of

the product structures, identification of product families, and componentization. To reduce the number of parts

and minimize the number of goods that are in process, it's very important that you understand the product

interfaces, and that you design for reusability.

There are several product configuration modeling principles, such as rule-based, dimension-based, and

constraint-based modeling. Studies show that the constraint-based methodology can reduce the number of code

lines in models by about 50 percent compared to other modeling principles. Therefore, this methodology can

reduce the total cost of ownership (TCO). By moving from a rule-based model that is based on X++ code to a

constraint-based model, you no longer require a developer license in order to maintain product models.

The industrialization period has led to great achievements in producing high-quality and feature-rich products

at affordable prices. The economies of scale have made it possible for most people in the industrialized world to

buy cars, TVs, household appliances, and other goods that most of us consider a necessary part of our everyday

life.

As many products have become commodities, a need to differentiate them has arisen. The immediate response

of manufacturers to this challenge has been to create variants of each product, so that customers have more

alternatives. This strategy has led to increased forecast challenges, and also to an increase in inventory cost and

unsold products that become obsolete.

By adopting a configure-to-order philosophy, manufactures have an opportunity to meet customer demand for

unique products while reducing or eliminating obsolete inventory items. When a manufacture-to-stock

philosophy is shifted to a configure-to-order philosophy, one immediate challenge that arises is that the need

for short lead times must be balanced against low inventory levels.

The key to success here is to carefully analyze the product portfolio, and to look for patterns in both product

features and processes. The goal is to identify generic components that can be manufactured by the same

equipment and used in all variants.

The new Product configuration feature set includes a user interface (UI) that provides a visual overview of the

product configuration model structure, and also a declarative constraint syntax that doesn't have to be compiled.

Therefore, companies that want to support a configuration practice can get started more easily. As the following

sections explain, a product designer no longer requires the support of a developer to build a product

configuration model, test it, and release it to the sales organization.

There are several approaches that a user can take to build a product configuration model. One option is to

follow a sequential flow by first creating all the reference data, such as product masters, distinct products, and

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/build-product-configuration-model.md
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Expression constraintsExpression constraints

Table constraintsTable constraints

CalculationsCalculations

SubcomponentsSubcomponents

User requirementsUser requirements

operational resources, and then including them as components, bill of materials (BOM) lines, route operations,

and other elements of the product configuration model. Alternatively, you can select a more iterative approach

by first creating the model and then adding reference data as the need arises.

A product configuration model consists of one or more components that are tied together through

subcomponent relationships. Components are defined one time, and can then be used many times in one or

more product configuration models. The components are the main building blocks of a product configuration

model, and nearly all information about the model is related to them.

Each component has one or more attributes that identify its properties. The attributes are what users will choose

during the configuration process. Attributes control both inter-component and intra-component relationships

through inclusion in constraints or calculations. Through conditions that are applied to BOM lines, the attributes

can be used to determine which physical parts the configured product will consist of. Additionally, an attribute

can control the property of a BOM line through a mapping mechanism. Similar functionality exists for route

operations regarding both inclusion and property settings.

When you create attribute types, avoid creating a high number of values for the attribute type domain. Doing so could

cause slowdowns in the product configurator.

Use of a constraint-based product configuration model implies that some limitations exist when the user selects

values for the various attributes. Such limitations can be implemented as expression constraints by using the

Optimization Modeling Language (OML). Alternatively, a constraint can be implemented in the form of a table

constraint.

Table constraints can be user-defined or system-defined.

A user-defined table constraint is built by the user. The user selects a combination of attribute types to represent

the columns of the table and then enters values from the domains of the selected attribute types to form the

rows in the table constraint.

A system-defined table constraint is defined by selecting which table to use as a reference and then selecting

fields from this table to form the columns in the constraint. The rows of the table constraint are the rows of the

Supply Chain Management table that are present at configuration time.

A table constraint is included in a product configuration model by referencing the table constraint definition and

mapping the relevant attributes in the model to the columns in the table constraint.

Calculations represent a mechanism for performing arithmetic operations in a configuration model. For

example, a calculation can determine the length of a specific piece of raw material or the processing time for a

polishing operation. Calculations are imperative and set the value for a target attribute after all the attribute

values that are included in the calculation expression become available.

Subcomponents represent the nodes in the product configuration model structure. For each subcomponent

relationship, a reference must be specified to a product master that has the variant configuration technology set

to constraint-based configuration.



BOM linesBOM lines

Route operationsRoute operations

Validating and testing a product configuration model

TestingTesting

The configuration pageThe configuration page

Finalizing a model for configuration

User interfaceUser interface

TemplatesTemplates

TranslationsTranslations

A user requirement has all the constituents of a subcomponent. The only difference is that a user requirement

isn't bound to a product master. The practical effect of this difference is that any BOM lines or route operation

that are defined in the context of a user requirement are collapsed into the parent component BOM structure or

route. This behavior resembles the behavior of a phantom BOM.

BOM lines are included to identify the manufacturing BOM for each component. A BOM line must reference an

item, and all item properties can be set to a fixed value or mapped to an attribute.

Route operations are included to identify the manufacturing route. A route operation must reference a defined

operation, and all operation properties can be set to a fixed value. All properties except resource requirements

can be mapped to an attribute instead of a value.

Validation of a product configuration model can occur on several levels in the model and can therefore cover

various scopes. The lowest level is for a single expression constraint. In this case, validation is typically

performed by the product designer to verify that the syntax of an expression is correct.

Similarly, a condition for a BOM line or a route operation can be validated in isolation.

Validation can also be done for a user-defined table constraint definition. In this case, the user can verify that the

values that are entered for each field are inside the domain of the corresponding attribute types.

Finally, validation can be done for a complete product configuration model to verify that the complete syntax is

correct, and that all naming and modeling conventions have been respected.

Testing a model is similar to running an actual configuration session. The user can walk through the

configuration pages and verify that the model structure supports the configuration process. The user can verify

that the attribute values are correct, and that the attribute descriptions guide the user to select the correct

values. Finally, after a test session is completed, the system tries to create the BOM and the route that

corresponds to the selected attribute values, and presents an error message if anything goes wrong.

To navigate between components, click NextNext, or click a component in the product configuration model tree to

set focus on it.

When a product configuration model is ready to be used in configure-to-order scenarios, a version must be

created. However, there are several options that can enhance the modeling experience.

The configuration UI can be modified by introducing attribute groups in one or more subcomponents. Such a

grouping can highlight the relationships between specific attributes and help the configuration user identify the

area of the product that is currently in focus.

One or more configuration templates can be created to speed up the configuration process. Alternatively,

templates can be created to promote specific attribute combinations, such as when a sales campaign focuses on

a specific set of product features.
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Extending a product configuration model through the API

PCAdaptor classPCAdaptor class

Product configuration

If the product will be sold in different countries/regions, translations can be created for all text that appears in

the configuration UI. This text includes not only name and description fields, but also attribute text values.

The last and most important step in the finalization process is to create a version for the product configuration

model. The version represents the relationship between the product master, which can be selected for

configuration on an order or quotation line, and the product configuration model. A version must be approved

and activated before it can be used in a configuration session.

A dedicated application programming interface (API) has been implemented, so that partners and others who

have a developer license can extend the capabilities of a product configuration model. The main goal has been

to establish a mechanism that lets partners and customers who use the existing Product Builder migrate the

code that is embedded in Product Builder models to the API. In this way, they can migrate their models from

Product Builder to a product configuration. However, new partners and customers can also benefit from using

the API to extend new product configuration models.

The API is implemented by using a set of PCAdaptorPCAdaptor  classes that expose the data structure of the product

configuration models. An instance of the PCAdaptorPCAdaptor  class must be created for each model that will be

extended. After a configuration session is completed, the system checks for an instance of this class and runs it if

it's found.

The following flow diagram outlines the process.

Product configuration API flow diagram

Product configuration can be performed from the following places:

Sales order line

Sales quotation line

Purchase order line

Production order line

file:///T:/eiye/ac1a/dynamics365/supply-chain/pim/media/product_configuration_2.png
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Item requirement line (project)

The purpose of the configuration is to create a distinct variant of the product that meets the customer’s

requirement. A unique configuration ID is created for each new configuration. This ID enables tracking through

inventory.

If configuration will be done at a site, or even a company, that differs from the site or company where

production will occur, the BOM and the route will be created for and put at the supplier site in the supplying

company. The product variant will be released in all companies that participate in the supply chain.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Key concepts

Product mastersProduct masters

Configuration product dimensionConfiguration product dimension

Configuration groupsConfiguration groups

Bill of materials (BOM)Bill of materials (BOM)

Configuration routeConfiguration route

Configuration rulesConfiguration rules

Dimension-based product configuration represents a simple solution for creating many product variants from a

single product master and its bill of materials.

Dimension-based product configuration is one of the three built-in product configuration technologies. The two

other technologies are predefined variants and constraint-based configuration. All three technologies use a

product master as the starting point and allow the user to create many product variants for one product master.

Dimension-based product configuration is based on the following key concepts:

Product masters

Configuration product dimension

Configuration groups

Bill of materials (BOM)

Configuration route

Configuration rules

A product master is the starting point for any product configuration process. For the dimension-based product

configuration, you need a product master with this particular configuration technology and a product dimension

group that includes the configuration product dimension.

The configuration product dimension is used to identify the product variants for a product master with the

dimension-based configuration technology. The configuration dimension value is entered by the user and

should help to identify the individual product variants.

Configuration groups are defined in a central repository and can be used for all dimension-based product

configuration models. Configuration groups are associated to the individual BOM lines and hold together a

group of lines that are mutually exclusive. This means that only one line in a group can be selected for a single

product variant.

The BOM represent the building blocks for a dimension-based product configuration. It must include all the

different products that can be used in any product variant. Each line in the BOM can reference a configuration

group. If a line doesn’t reference a configuration group, it will be included in all product variants.

The configuration route determines the sequence of the configuration groups, as they will be displayed to the

user during the product configuration process.

The configuration rules represent a mechanism for ensuring that a product included in one configuration group

in a BOM enforces either an inclusion or an exclusion of a product in a different configuration group in the same

BOM.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/dimension-based-product-configuration.md
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The natural sequence for building a product model for a dimension-based product starts with defining the

relevant configuration groups. It is important to ensure that all products which will be used in the BOM have

been released to the company that the product model is built for. With these building blocks in place, the user

can create the BOM and assign configuration groups to all relevant BOM lines. When the BOM is complete, a

configuration route can be defined for ordering the configuration groups in the proper sequence. 

If there are certain products from different configuration groups that either must or must not be used together,

you can create configuration rules that will enforce these product relationships. After the BOM has been tied

together with a dimension-based product master through a BOM version and both have been approved and

activated, you can create product configurations and enter a name for each configuration. The configurations

can be defined before any transactions are generated or it can be done when the need for a certain

configuration occurs.

The dimension-based configuration technology is best used for products with limited variability and the

combination of the standard product dimensions size, color, style, and configuration is unsuitable for identifying

a specific product variant. An example could be bicycle with frame height, wheel size, brake types, and different

gears.

The following eight task guides are listed in the order in which you should complete them.

1. Create a dimension-based product master

2. Release a dimension-based product master

3. Complete basic setup of a released product master

4. Define configuration groups

5. Create a bill of materials for a dimension-based product master

6. Define configuration routes

7. Create configuration rules

8. Create dimension-based configurations

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Product variants

Product dimensions

There are five product dimensions: color, configuration, size, style, and version. You combine product dimensions

in dimension groups and assign dimension groups to product masters. The combinations of product

dimensions determine how product variants are defined.

Product dimensions are characteristics that serve to identify a product variant. You can use combinations of

product dimensions to define product variants. You must define at least one product dimension for a product

master in order to create a product variant.

Product variants are also referred to as items. An item is a tangible product, which isn't the same as a service. It's

also possible to define a product master with the service type. By using the service type, you can specify product

variants that include services. For example, you can specify a product master for consultancy work and product

variants for work that is performed by senior consultants and junior consultants.

A product variant can be generated based on the product dimension values.

Product dimension values for the size, color, and style dimensions can be created in the following locations:

S izeSize page (Product information management > Setup > Dimension and var iant groups > S izesProduct information management > Setup > Dimension and var iant groups > S izes )

ColorColor  page (Product information management > Setup > Dimension and var iant groups >Product information management > Setup > Dimension and var iant groups >

ColorsColors )

StyleStyle page (Product information management > Setup > Dimension and var iant groups > StylesProduct information management > Setup > Dimension and var iant groups > Styles )

Product dimension values for the configuration dimension are typically created by using either the Product

configurator or the Dimension-based configurator.

Product versions are usually created for specific versions as the product evolves during its lifecycle. Product

versions are covered in detail later in this topic.

Product dimensions can also be created and maintained on the Product dimensionsProduct dimensions  page, which can be

accessed from the following locations:

Go to Product information management > Products > Product mastersProduct information management > Products > Product masters . On the Action Pane, select

Product dimensionsProduct dimensions .

Go to Product information management > Products > All products and product mastersProduct information management > Products > All products and product masters . Select a

product master. On the Action Pane, select Product dimensionsProduct dimensions .

Go to Product information management > Released productsProduct information management > Released products . Select a product master. On the Action

Pane, on the ProductProduct tab, in the Product masterProduct master  group, select Product dimensionsProduct dimensions .

The number of variants that you can create for an item is limited by the number of possible product dimension

combinations.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/product-dimensions.md
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The version product dimension

Turn on the version dimensionTurn on the version dimension
Before you turn on the version dimensionBefore you turn on the version dimension

When you use a product on an order line, for example, you select the product dimensions to identify the product variant

that you want to work with.

A company sells denim jeans. The item, Jeans, uses the color and size product dimensions. The jeans are sold in

three different colors and six different sizes. The colors are blue, black, and brown. The sizes are XS, S, M, L, XL,

and XXL. Not all sizes are available in all three colors. If all combinations were available, there would be 18

different types of jeans. However, in this example, only the following nine product variant combinations are

produced.

Version is a product dimension that is intended to help you maintain and track multiple versions of a product

throughout the supply chain. Version tracking is essential to the success of manufacturers that operate in a

world ofconstantly shrinking product lifecycles, increased quality and reliability requirements, and increased

focus on product safety.

As a standard product dimension, version will behave similarly to the existing product dimensions (size, style,

color, and configuration). Therefore, you can use it for other purposes besides tracking product versions.

When you turn on the version dimension, some functionality could become broken or stop working as expected

if you've installed other solutions that add customizations to the inventory dimensions. For the version

dimension to be fully functional, you might have to update those solutions so that they include the version

dimension in their references to the inventory dimensions.

When you're testing your solutions for compatibility with the version dimension, look for the following

elements:



Turn on the version dimensionTurn on the version dimension

Areas where the version dimension isn't supportedAreas where the version dimension isn't supported

1. Functionality:Functionality: Most importantly, any customizations that involve the inventory dimensions must be

assessed to ensure that they can work in conjunction with the version dimension.

2. References to the inventor y dimensions:References to the inventor y dimensions: Look out for references to the inventory dimensions (that

is, places where the dimensions are explicitly referenced). References to InventDimId  should work out of

the box, but look out for references to style or color. For example, be sure to check the following elements:

API calls in extended classes

All references to specific inventory dimensions in extension code (This code must float the version

dimension together with the style, color, and size dimensions.)

3. References to obsolete API calls :References to obsolete API calls : In its introduction of the version dimension, Microsoft has tried to

make as few APIs as possible obsolete. The few APIs that have been made obsolete will issue a warning

when you turn on the Product dimension - versionProduct dimension - version configuration key. Calls to those API must be fixed

in your extended solutions before you turn on the version dimension in a production system. Here are

the version-specific obsolete APIs:

RetailTransactionServiceInventory::getProductRecordId

EcoResProductNumberIdentifiedProductVariantEntity::find

EGAISAlcoholProduction_RU::findByItemDim

PCVariantConfiguration::findByProductMasterAndDimensions

4. Maps:Maps: If any maps use the inventory dimensions, the corresponding relation mapping to these maps

must be updated so that they include the version dimension. In the extended model or table extensions,

look out for tables where the fields include inventory dimensions.

5. Microsoft Dynamics 365 Commerce functionality:Microsoft Dynamics 365 Commerce functionality: After it's turned on, the version dimension will

appear throughout the Commerce-specific code in Dynamics 365 Supply Chain Management. However,

the version dimension isn't yet supported by the Commerce channel database or in the Point of Sale

(POS) or e-Commerce applications. These Commerce-specific applications won't support users

selling/shipping or returning/receiving inventory by version dimension. Inventory availability lookup

functions won't discern inventory by version dimension in Commerce apps. This behavior resembles the

current behavior of the config dimension throughout Commerce.

Before you can use the version dimension, it must be turned on in your system. This task requires admin

permissions.

1. Go to System administration > Workspaces > Feature managementSystem administration > Workspaces > Feature management.

2. Turn on the feature that is named Product dimension version. (For more information, see Feature

management.)

3. Put your system into Maintenance mode.

4. Go to System administration > Setup > L icense configurationSystem administration > Setup > L icense configuration.

5. On the Configuration keysConfiguration keys  tab, expand TradeTrade, and select the check box for Product dimension -Product dimension -

versionversion.

6. Turn off Maintenance mode.

The following areas don't support the version dimension (you can still use these areas but you won't be able to

add versioned products (products where the version dimension is used) to them). For example, you can't add a

versioned item to a vendor catalog. This is because adding products with the version dimension to these areas

would cause breaking changes.

Cost object monthly statement

Cost object statement cache

MCR sales statistics per item

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/sysadmin/maintenance-mode
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/sysadmin/maintenance-mode


Functional characteristics of the version dimensionFunctional characteristics of the version dimension

IMPORTANTIMPORTANT

NOTENOTE

Vendor catalogs

EcoResProductDimensionGroupEntity

In addition, the order creation and order processing features in Commerce (for example, for POS, call center, and

e-commerce orders) don't support the version dimension. There is no confirmed timeline as to when Commerce

orders will be enhanced to support it.

The version dimension works like the other product dimensions. However, because of its specific nature, and

because it's intended to maintain and track multiple versions of a product, it behaves slightly differently. Here

are some of the differences and similarities:

There is no version group.There is no version group.

Although the concept of groups exists for size, color, and style (color group, size group, and style group),

no version group concept exists. Groups let you predefine the applicable values so that when, for

example, you assign a color group to a product, the product can use all the colors in that color group. This

concept doesn't apply to the version dimension, because the versions that a product takes aren't

predefined when the product is created. Instead, versions are created during the lifecycle of the product,

as they are required. Typically, if the form, fit, and function of the product remain the same, you create a

new version instead of a new product.

Product var iant suggestions work as they currently do.Product var iant suggestions work as they currently do.

Product variant suggestions will create suggestions for all version dimension values, just as they do for

other dimensions. The process of creating and releasing versioned products is the same as it is for

products that use other dimensions. When you create a versioned product, the first version (V1) will be

created as a product dimension, and the variants will be released. As the product changes and a new

version is needed, the new version value (V2) will be added, and the required variants will be released.

There is no expectation that all the versions (V1, V2, and V3) will be created in advance for the product.

If you turn on and use the version dimension, some solutions that reference the inventory dimensions might stop

working as expected. To confirm and fix these issues, contact the independent software vendor (ISV) for your affected

solutions. For more information, see Enable the version dimension.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a dimension-based product master
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NOTENOTE

This procedure shows how to create a new product master with dimension-based configuration technology. The

demo data company used to create this procedure is USMF. This is the first procedure out of eight that explains

how to build combinations for dimension-based configuration.

1. Go to Product information management > Products > Product masters.

2. Click New.

3. In the Product number field, type a value.

4. In the Product name field, type a value.

5. In the Product dimension group field, click the drop-down button to open the lookup.

6. In the list, find and select the desired record.

7. In the list, click the link in the selected row.

8. In the Configuration technology field, select an option.

9. Click OK.

Entering a product number is mandatory if no number sequence has been set up for the product

number field.

Select the configuration dimension for this procedure.

Select the Dimension-based configuration technology.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/create-dimension-based-product-master.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

This procedure shows how to release a product master, which will be used for the dimension-based

configurations. The demo data company used to create this procedure is USMF. It is a prerequisite that you have

created a product master with the dimension-based configuration technology. This is the second procedure out

of eight which explains how to build combinations for dimension-based configuration.

1. Go to Product information management > Products > Product masters.

2. In the list, mark the selected row.

3. Click Release products.

4. Click Next.

5. Click Next.

6. In the list, find and select the desired record.

7. Click Next.

8. Click Finish.

Filter the Configuration technology column so that only the dimension-based configuration is

displayed. For example, you can filter the column by typing Dimension.

For products that are crated with the dimension-based configuration technology, the product variants

must be created in the company where the bill of materials will be created.

Select the company USMF for this procedure.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/release-dimension-based-product-master.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

This topic shows how to complete the minimum setup that is required before the product master can be used in

BOM versions.

This is the third procedure out of eight which explains how to build combinations for dimension-based

configuration. The demo data company used to create this procedure is USMF.

1. Go to Navigation pane > Modules > Product information management > Products > ReleasedNavigation pane > Modules > Product information management > Products > Released

productsproducts .

2. In the list, find and select the desired record. Select the product master that you have released in the second

procedure. This product master is created with the dimension-based configuration technology.

3. On the Action Pane, select ProductProduct.

4. Select Dimension groupsDimension groups  to open the drop dialog.

5. In the Storage dimension groupStorage dimension group field, select the drop-down button to open the lookup.

6. In the list, find and select the desired record. The storage dimension group determines which storage

dimensions are used for product transaction. Select S iteSite for this procedure.

7. In the Tracking dimension groupTracking dimension group field, select the drop-down button to open the lookup.

8. In the list, find and select the desired record. The tracking dimension group determines which tracking

dimensions are used for product transaction. Select NoneNone for this procedure.

9. Click OKOK.

10. Click EditEdit.

11. In the Item model groupItem model group field, select the drop-down button to open the lookup.

12. In the list, find and select the desired record. Item model groups contain settings that determine how items

are controlled and handled on item receipts and issues. They also determine how item consumption is

calculated. Select FIFOFIFO for this procedure.

13. Expand the Manage costsManage costs  section.

14. In the Item groupItem group field, select the drop-down button to open the lookup.

15. In the list, find and select the desired record. Item groups are used to manage inventory by dividing

inventory items into groups. Select CarAudioCarAudio for this procedure.

16. On the Action Pane, select PlanPlan.

17. Select Default order settingsDefault order settings .

18. In the Default order type fieldDefault order type field, select an option. Select ProductionProduction to specify that the default supply

option for this product master is to produce it.

19. Select SaveSave.

20. Close the page.

21. Close the Released product detailsReleased product details  form.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/complete-basic-setup-released-product-master.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

This procedure shows how to define product configuration groups by creating two groups in the demo data

company USMF Company. This is the fourth procedure out of eight which explains how to build combinations

for dimension-based configuration.

1. Go to Product information management > Setup > Bills of materials and formulas > Configuration groups.

2. Click New.

3. In the Configuration group field, type a value.

4. In the Name field, type a value.

5. Click New.

6. In the Configuration group field, type a value.

7. In the Name field, type a value.

8. Close the page.

Type a name for the configuration group that will be used for the bill of material lines.

Type a name for the configuration group that will be used for the bill of material lines.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/define-configuration-groups.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a bill of materials for a dimension-based
product master
2/18/2021 • 2 minutes to read • Edit Online

Select the product

Create new BOM and BOM version

For this procedure you should have completed the previous 4 guides in this sequence of eight recordings. The

first 4 recordings set up data that is required to complete this procedure. The demo data company used to

create this procedure is USMF. This task is typically handled by the product designer.

1. Click Released product maintenance.

2. Click Released products.

3. In the list, mark the selected row.

4. On the Action Pane, click Engineer.

5. Click BOM versions.

Find the released product master with dimension-based configuration technology that you created in

the first task guide in this sequence.

1. Click New.

2. Click BOM and BOM version.

3. In the Name field, type a value.

4. Click OK.

5. Click New.

6. In the list, mark the selected row.

7. In the Item number field, enter or select a value.

8. In the Configuration group field, enter or select a value.

9. Click New.

10. In the list, mark the selected row.

11. In the Item number field, enter or select a value.

12. In the Configuration group field, enter or select a value.

13. Click New.

14. In the list, mark the selected row.

15. In the Item number field, enter or select a value.

16. In the Configuration group field, enter or select a value.

Setting a site

In this procedure we don't set a specific site for the BOM.

In this procedure we will add four lines to the BOM. Two lines represent cable options and two lines

represent cabinet options.

Select item number A0001, HDMI 6' Cables.

Select the Cable configuration group created in guide 4 in this sequence.

Select item number A0002, HDMI 12' Cables.

Select the Cable configuration group again.

Select item number D0002 Cabinet.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/create-bill-materials-dimension-based-product-master.md


Approve and activate
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17. Click New.

18. In the list, mark the selected row.

19. In the Item number field, enter or select a value.

20. In the Configuration group field, enter or select a value.

Select the Cabinet configuration group for this BOM line.

Select Item number M0007 StandardCabinet as the last BOM line.

Select the Cabinet configuration group for the laste BOM line.

1. Close the page.

2. Click Approve.

3. In the Approved by field, enter or select a value.

4. Select Yes in the Do you also want to approve the bill of materials? field.

5. Click OK.

6. Click Activate.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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This procedure focuses on defining a configuration route that determines the sequence in which the

configuration groups will be presented. The demo data company used to create this procedure is USMF. This is

the sixth procedure out of eight that explains how to build combinations for dimension-based configuration.

1. Go to Product information management > Bills of materials and formulas > Bills of materials.

2. In the list, find and select the desired record.

3. On the Action Pane, click Options.

4. Click Change view.

5. Click Header view.

6. Expand or collapse the Configuration route section.

7. Click Add.

8. In the list, mark the selected row.

9. In the Configuration group field, click the drop-down button to open the lookup.

10. In the list, click the link in the selected row.

11. Click Add.

12. In the list, mark the selected row.

13. In the Configuration group field, click the drop-down button to open the lookup.

14. In the list, find and select the desired record.

15. In the list, click the link in the selected row.

16. Click Save.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/define-configuration-route.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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This procedure creates configuration rules that can be used for dimension-based configuration to enforce or

prevent certain combinations of BOM lines. The demo data company used to create this procedure is USMF. This

is the seventh procedure out of eight that explains how to build combinations for dimension-based

configuration.

1. Go to Product information management > Bills of materials and formulas > Bills of materials.

2. In the list, find and select the desired record.

3. On the Action Pane, click Options.

4. Click Change view.

5. Click Header view.

6. Expand or collapse the Configuration route section.

7. Click Configuration rules.

8. Click New.

9. In the list, mark the selected row.

10. In the Item number field, click the drop-down button to open the lookup.

11. In the list, click the link in the selected row.

12. In the Method field, select an option.

13. In the Derived group field, click the drop-down button to open the lookup.

14. In the list, find and select the desired record.

15. In the list, click the link in the selected row.

16. In the Derived item number field, click the drop-down button to open the lookup.

17. In the list, click the link in the selected row.

18. Close the page.

Find and select the BOM for the dimension-based configuration.

Open the header view to access the Configuration route FastTab.

The Configuration route FastTab must be in the expanded mode.

The items in the current configuration group are displayed. Select the one that represents the

condition in the rule.

It is possible to enforce either a selection or a deselection of an item from another configuration

group.

Select the desired configuration group.

Select the item number that will be either selected or deselected depending on the chosen method.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/create-configuration-rules.md
https://aka.ms/BAG_Docs_Language_Survey
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Find the dimension-based product master

Create configurations

NOTENOTE

This procedure shows how to define a configuration for a dimension-based product. This is the last procedure in

the series that explains how to build combinations for dimension-based configuration. The execution of this

procedure is dependent on the data created in the previous seven recordings. The demo data company used to

create this procedure is USMF.

1. Click Released product maintenance.

2. Click Released products.

3. In the list, mark the selected row.

Select the dimension-based product master that you created in the first recording in this sequence of

8 recordings.

1. On the Engineering Action Pane, click Maintain configurations.

2. Click Configure.

3. In the list, mark the selected row.

4. In the Item number field, enter or select a value.

5. In the list, find and select the desired record.

6. In the Item number field, enter or select a value.

7. Click OK.

8. In the list, mark the selected row.

9. In the Configuration field, type a value.

10. In the Description field, type a value.

11. Click OK.

Select any of the items in the first configuration group.

Select any item from the second configuration group.

Enter a configuration name that will make it easy to identify the configuration.

Enter a description of the configuration to explain what it contains.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/create-dimension-based-configurations.md
https://aka.ms/BAG_Docs_Language_Survey
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Create a product master. Create a product master from the Product masterProduct master  list.
Release the product master to all relevant companies. For a
product master that is used as a version for a product
configuration model or as a subcomponent, Constraint-Constraint-
based configurationbased configuration must be selected as the
configuration technology, and the configuration dimension
must be selected only for the product dimension group.

Create components. Create components on the ComponentsComponents page.
Components are the building blocks of a product
configuration model and can be reused in multiple product
configuration models.

Create attribute types. Create attribute types on the Attribute typesAttribute types page.
Attribute types specify the set of data types for all attributes
that are used in product configuration models. Attributes of
the BooleanBoolean, TextText  with a fixed list, and IntegerInteger  with a
range types list the set of values that are available when you
configure a product variant based on a product
configuration model.

Create a product configuration model. Create a product configuration model on the New productNew product
configuration modelconfiguration model page.

Add attributes to a product configuration model. Create an attribute on the AttributesAttributes FastTab on the
Constraint-based product configuration modelConstraint-based product configuration model
detailsdetails  page. Attributes describe the features of the product
configuration model.

Add constraints to a product configuration model. Create constraints on the ConstraintsConstraints  FastTab on the
Constraint-based product configuration modelConstraint-based product configuration model
detailsdetails  page. Constraints are limitations that a product
configuration must satisfy. Constraints are either expression
constraints or table constraints.

Add subcomponents to a product configuration model. Create subcomponents on the SubcomponentsSubcomponents FastTab on
the Constraint-based product configuration modelConstraint-based product configuration model
detailsdetails  page. Subcomponents are related to components
and are linked to items that represent the subcomponent.

Add user requirements to a product configuration model. User requirements are similar to subcomponents, but they
don't reference an item. You can think about user
requirements as a phantom BOM. Any BOM lines or route
operations that are placed directly under the user
requirement will be collapsed into the parent component.

This article describes the steps for setting up and creating a product configuration model.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/set-up-maintain-product-configuration-model.md


Add BOM lines to a product configuration model. Create BOM lines on the BOM linesBOM lines FastTab on the
Constraint-based product configuration modelConstraint-based product configuration model
detailsdetails  page. BOM lines represent a part that is required to
build a variant of the product.

Add route operations to a product configuration model. Create route operations on the Route operationsRoute operations FastTab
on the Constraint-based product configuration modelConstraint-based product configuration model
detailsdetails  page. Route operations represent a step in a
sequence of steps that are performed to make a variant of
the product.

Create an active version for a product configuration model. Create an active version of the product configuration model
on the VersionsVersions page. A version is the relationship between
a product configuration model and a product master. A
product configuration model that has an active version can
be configured from a sales order, sales quotation, purchase
order, or production order.

Test a product configuration model. Test the product configuration model from either the
Constraint-based product configuration modelConstraint-based product configuration model
detailsdetails  page or the Product configuration models listProduct configuration models list
page. Testing the product configuration models simulates
the product model configuration process that occurs during
order handling.

Create product configuration model template. Create a product configuration model template on the
Configuration templatesConfiguration templates page. A configuration template
includes values for attributes in the product configuration
model. Select the attribute values on the Configure lineConfigure line
page. You can select to load a product model configuration
template during product model configuration.

Configure an item. Product configuration models can be configured from a sales
order, sales quotation, purchase order, or production order.

TA SKTA SK DESC RIP T IO NDESC RIP T IO N

NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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What is a calculation?

What is a target attribute?

What attribute types can be set to target attributes?

Can the value of a target attribute restrict the values of the input
attributes in a calculation?

ExampleExample

This topic describes calculations for product configuration models and explains how to use calculations together

with constraints.

Calculations can be used for arithmetic or logical operations. They complement expression constraints in

product configuration models. You can define calculations on the Constraint-based product configurationConstraint-based product configuration

model detailsmodel details  page and then build expressions for the calculations in the expression editor. For more

information, see Create calculations.

A calculation is an element that you can use in a product configuration model. Calculations complement

constraints by letting you use decimal numbers to calculate values when you configure a product. Additionally,

calculations have a larger set of available operators than constraints have.

Like a constraint, a calculation is associated with a specific component in a product configuration model, and

can’t be reused by or shared with another component. One important difference between calculations and

constraints is that calculations are imperative (unidirectional), whereas constraints are declarative (bi-

directional). For more information about constraints, see Expression constraints and table constraints in product

configuration models.

A calculation consists of a target attribute and a calculation expression.

A target attribute is an attribute that receives the result of the calculation expression.

In the following expression, the target attribute is a tablecloth measurement:

Expression:Expression: If[decimalAttribute1 <= decimalAttribute2, True, False]

DecimalAttr ibute1DecimalAttr ibute1  is the table length, and decimalAttr ibute2decimalAttr ibute2  is the tablecloth length. The expression returns

the value TrueTrue to the target attribute if decimalAttr ibute2decimalAttr ibute2  is greater than or equal to decimalAttr ibute1decimalAttr ibute1 .

Otherwise, the expression returns FalseFalse. Therefore, the tablecloth measurement is acceptable if the tablecloth

length is the same as or exceeds the length of the table.

All attribute types that the product configurator supports can be set to target attributes, except text without a

fixed list.

No, the value of a target attribute can’t restrict the values of the input attributes, because calculations are

unidirectional. Therefore, the value of the target attribute is set based on changes in the value of the input

attributes, but a change in the value of the target doesn’t affect the value of the input attributes. This behavior

differs from the behavior for constraints. Constraints occur in both directions.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/calculate-product-configuration-models.md


What happens if a calculation has a target attribute of the integer
type but a calculation generates a decimal number?

When do calculations occur?

Can I overwrite the value that is calculated for the target attribute?

How do I set a target attribute as hidden or read-only?

Can a calculation overwrite the values that I set?

What happens if I remove an input value in a calculation?

Why do I receive an error message that says that my model is in
contradiction?

In the following expression, the target for the calculation is the length of a power cord, and the input value is a

color :

Expression:Expression: [If Color == "Green", 1.5, 1.0]

When you configure the item, the length of the power cord is set to 1.51.5  if you specify GreenGreen as the value of

color attribute. If you specify any other color, the length is set to 1.01.0 . However, because calculations are

unidirectional, the calculation doesn't set the value of the color attribute to GreenGreen if you specify a length of 1 .51.5 .

If a target attribute is of the integer type, but a calculation generates a decimal number, only the integer part of

the calculated result is returned. The decimal part is removed, and the result isn't rounded. For example, a result

of 12.70 is shown as 12.

Calculations occur when a value has been provided for all input attributes.

You can overwrite the value that is calculated for the target attribute, unless the target attribute is set as hidden

or read-only.

To set an attribute as hidden or read-only, follow these steps.

1. Click Product information managementProduct information management > CommonCommon > Product configuration modelsProduct configuration models .

2. Select a product configuration model, and then, on the Action Pane, click EditEdit.

3. On the Constraint-based product configuration model detailsConstraint-based product configuration model details  page, select the attribute to use as a

target attribute.

4. On the Attr ibutesAttr ibutes  FastTab, select HiddenHidden or Read-onlyRead-only .

No. The values that you set when you configure a product are the values that are used. The calculation that

occurs when the input values in a calculation are changed can’t overwrite the values that you provide for a

specific attribute.

If you remove an input value in a calculation, the value of the target attribute is also removed.

This message is shown when a calculation includes an error, or when a contradiction exists in one or more

constraints. For more information about contradictions in constraints, see Expression constraints and table

constraints in product configuration models. Here are some situations where errors can occur in calculations:

A value is divided by 0 (zero).

A conflict exists between the following two elements:



Why do I receive an error message even though I successfully
validated my product model?

NOTENOTE

The values that are returned by the calculation are outside the domain of the attribute. An example is an

integer from [1..10] that is calculated to 0.

The values that are available for an attribute and are limited by a constraint

A value that is generated by a calculation

Calculations aren't included in the validation. You must test the product configuration model to find errors in

calculations. To test a product configuration model, follow these steps.

1. Click Product information managementProduct information management > CommonCommon > Product configuration modelsProduct configuration models .

2. Select a product configuration model, and then, on the Action Pane, in the RunRun group, click TestTest.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Additional resources

NOTENOTE

This article provides general information about configuration rules. Configuration rules define relationships

between items in a bill of materials (BOM) for products that use the dimension-based configuration technology.

Configuration rules are available when you define dimension-based configuration models. Configuration rules

are used to either enforce or prohibit specific item combinations in a bill of materials (BOM). After a BOM has

been created and the relevant items have been assigned to their respective configuration groups, one or more

configuration rules can be defined. If two items belong together, the SelectSelect operator is used to ensure inclusion.

If two items are mutually exclusive, the DeselectDeselect operator is used to ensure exclusion.

Note:Note: This information applies only to product masters that use the dimension-based configuration technology.

Existing configurations aren't affected by subsequent changes to the configuration rules. However, it's important

that you set the rules before you define a new configuration, and that you check the rules if you think they have

been changed.

Note:Note: For the SelectSelect method, the derived configuration group, item number, and configuration are

automatically selected. For the DeselectDeselect method, the derived configuration group, item number, and

configuration can't be selected.

Dimension-based product configuration overview
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What are expression constraints?

What are table constraints?

Example of a table constraintExample of a table constraint
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Cabinet finish Black, Oak, Rosewood, White

Front grill Black, Metal, White
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Oak Black

Rosewood White

White Black

This topic describes the use of expression constraints and table constraints. Constraints control the attribute

values that you can select when you configure products for a sales order, sales quotation, purchase order, or

production order. You can use expression constraints or table constraints, depending on how you prefer to build

the constraints.

Constraints are used to control the attribute values that you can select when you configure products for a sales

order, sales quotation, purchase order, or production order. You can use expression constraints or table

constraints, depending on how you prefer to build the constraints.

Expression constraints are characterized by an expression that uses arithmetic and Boolean operators and

functions. An expression constraint is written for a specific component in a product configuration model. It can't

be reused by or shared with another component. However, the expression constraints for a component can

reference attributes of the component's subcomponents.

Table constraints list the combinations of values that are allowed for attributes when you configure a product.

Table constraint definitions can be used generically. When you create a table constraint for a component in a

product configuration model, you select a table constraint definition. To create the combinations that are

allowed, you add attributes of specific types to the components. Each attribute type has a specific value.

This example shows how you can limit the configuration of a speaker to specific cabinet finishes and fronts. The

first table shows the cabinet finishes and fronts that are generally available for configuration. The values are

defined for the Cabinet finishCabinet finish and Front gr illFront gr ill  attribute types.

The next table shows the combinations that are defined by the Color and finishColor and finish table constraint. By using this

table constraint, you can configure a speaker that has an oak finish and a black grill, a Rosewood finish and a

white grill, and so on.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/expression-constraints-table-constraints-product-configuration-models.md
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Black Black

Black Metal
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What syntax should be used to write constraints?

Should I use table constraints or expression constraints?

Table constraint setupTable constraint setup

C O LO RC O LO R SIZ ESIZ E

Black 30

Black 50

Red 20

Expression constraint setupExpression constraint setup

Should I use operators or infix notation when I write expression
constraints?

What operators and infix notation can I use when I write expression
constraints?

You can create system-defined and user-defined table constraints. For more information, see System-defined

and user-defined table constraints.

You must use Optimization Modeling Language (OML) syntax when you write constraints. The system uses

Microsoft Solver Foundation constraint solver to solve the constraints.

You can use either expression constraints or table constraints, depending on how you prefer to build the

constraints. You build a table constraint as a matrix, whereas an expression constraint is an individual statement.

When you configure a product, it doesn't matter what kind of constraint is used. The following example shows

how the two methods differ.

When you configure a product by using the following constraint setups, these combinations are allowed:

A product in the color Black, and in size 30 or 50

A product in the color Red and in size 20

(Color == "Black" & (size == "30" | size == "50")) | (color == "Red" & size = "20")

You can write an expression constraint by using either the available prefix operators or infix notation. For the

MinMin, MaxMax, and AbsAbs  operators, you can't use infix notation. These operators are included as standard operators

in most programming languages.

The following tables list the operators and infix notation that you can use when you write an expression

constraint for a component in a product configuration model. The examples in the first table show how to write
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Implies This is true if the first
condition is false, the
second condition is true, or
both.

Implies[a, b], infix: a -: b

And This is true only if all
conditions are true. If the
number of conditions is 0
(zero), it produces TrueTrue.

And[args], infix: a & b & ...
& z

Or This is true if any condition
is true. If the number of
conditions is 0 (zero), it
produces FalseFalse.

Or[args], infix: a | b | ... | z

Plus This sums its conditions. If
the number of conditions is
0 (zero), it produces 00 .

Plus[args], infix: a + b + ... +
z

Minus This negates its argument.
It must have exactly one
condition.

Minus[expr], infix: -expr

Abs This takes the absolute
value of its condition. It
must have exactly one
condition.

Abs[expr] Operator :Operator :  Abs[x]

Times This takes the product of its
conditions. If the number of
conditions is 0 (zero), it
produces 11 .

Times[args], infix: a * b * ... *
z

Power This takes an exponential. It
applies exponentiation from
right to left. (In other
words, it's right-associative.)
Therefore, Power[a, b, c]Power[a, b, c] is
equivalent to Power[a,Power[a,
Power[b, c]]Power[b, c]] . PowerPower  can
be used only if the
exponent is a positive
constant.

Power[args], infix: a ^ b ^ ...
^ z

Max This produces the largest
condition. If the number of
conditions is 0 (zero), it
produces InfinityInfinity .

Max[args] Operator :Operator :  Max[x, y, 2] ==
z

an expression by using either infix notation or operators.

Operator :Operator :  Implies[x
!= 0, y >= 0]

Infix notation:Infix notation:  x !=
0 -: y >= 0

Operator :Operator :  And[x
== 2, y <= 2]

Infix notation:Infix notation:  x
== 2 & y <= 2

Operator :Operator :  Or[x ==
2, y <= 2]

Infix notation:Infix notation:  x
== 2 | y <= 2

Operator :Operator :  Plus[x, y,
2] == z

Infix notation:Infix notation:  x +
y + 2 == z

Operator :Operator :  Minus[x]
== y

Infix notation:Infix notation:  -x
== y

Operator :Operator :  Times[x,
y, 2] == z

Infix notation:Infix notation:  x *
y * 2 == z

Operator :Operator :  Power[x,
2] == y

Infix notation:Infix notation:  x ^
2 == y



Min This produces the smallest
condition. If the number of
conditions is 0 (zero), it
produces InfinityInfinity .

Min[args] Operator :Operator :  Min[x, y, 2] ==
z

Not This produces the logical
inverse of its condition. It
must have exactly one
condition.

Not[expr], infix: !expr

O P ERATO RO P ERATO R DESC RIP T IO NDESC RIP T IO N SY N TA XSY N TA X EXA M P L ESEXA M P L ES
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x + y + z Addition

x * y * z Multiplication

x - y Binary subtraction is translated the same as binary addition
where there is a negated second.

x ^ y ^ z Exponentiation that has right associativity

!x Boolean not

x -: y Boolean implication

x y

x & y & z Boolean and

x == y == z Equality

x != y != z Distinct

x < y < z Less than

x > y > z Greater than

x <= y <= z Less than or equal to

x >= y >= z Greater than or equal to

(x) Parentheses override default precedence.

Why aren't my expression constraints validated correctly?

Operator :Operator :  Not[x] &
Not[y == 3]

Infix notation:Infix notation:  !x!
(y == 3)

The examples in the next table show how to write infix notation.

You can't use reserved keywords as solver names for attributes, components, or subcomponents in a product

configuration model. Here is a list of the reserved keywords that you can't use:

Ceiling



Additional resources

NOTENOTE

Element

Equal

Floor

If

Less

Greater

Implies

Log

Max

Min

Minus

Plus

Power

Times

Slot

Model

Decision

Goal

Create an expression constraint

Add a calculation to a product configuration model
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Solver strategy

Change the settings for the solver strategy

This topic describes how you can use the solver strategy to improve the performance of product configuration.

The concept of solver strategies was first introduced in Cumulative update 7 (CU7) for Microsoft Dynamics AX

2012 R2. It was extended in Cumulative update 8 (CU8) for Microsoft Dynamics AX 2012 R3 and Microsoft

Dynamics 365 for Finance and Operations, Enterprise edition 7.3.

The solver strategy concept now consists of the following strategies:

Default

Minimal domains first

Top-down

Z3

A product configuration model can be formulated as a constraint satisfaction problem (CSP). Microsoft Solver

Foundation (MSF) provides two types of solver strategies to solve the CSPs that can be used from product

configuration models. These solver strategies rely on heuristics, which are used to determine the order that the

variables of the CSPs are considered in when the problem is being solved. Heuristics can significantly affect

performance when a problem or class of problems is being solved.

The solver strategy for product configuration models determines which solver is used with heuristics. The

DefaultDefault, Minimal domains firstMinimal domains first, and Top-downTop-down strategies use the two solvers from MSF, whereas the Z3Z3

strategy uses the Z3 solver.

Real customer implementation studies have shown that a change in the solver strategy for a product

configuration model can reduce the response time from minutes to milliseconds. Therefore, it's worth the effort

to try different solver strategies to find the most efficient strategy for your product configuration model.

To change the solver strategy, on the Product configuration modelsProduct configuration models  page, on the Action Pane, select ModelModel

proper tiesproper ties . Then, in the Edit the model detailsEdit the model details  dialog box, select a solver strategy.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/solver-strategy-product-configuration.md
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Default The DefaultDefault  strategy has been optimized to solve models
that rely on table constraints. Customer implementation
studies have shown that this strategy is the most efficient
strategy in scenarios where table constraints are used
extensively.

Minimal domains first The Minimal domains firstMinimal domains first  and Top-downTop-down strategies are
closely related. Customer implementation studies have
shown that the Top-downTop-down strategy, outperforms the
Minimal domains firstMinimal domains first  strategy. However, the MinimalMinimal
domains firstdomains first  strategy is kept in the product for backward
compatibility. Both these solver strategies have been shown
to be more efficient at solving models that contain several
arithmetic expressions where no table constraints are used.
However, in some cases, the DefaultDefault  strategy outperforms
these two strategies. Therefore, remember to try each
strategy.

Top-down The Minimal domains firstMinimal domains first  and Top-downTop-down strategies are
closely related. Customer implementation studies have
shown that the Top-downTop-down strategy, outperforms the
Minimal domains firstMinimal domains first  strategy. However, the MinimalMinimal
domains firstdomains first  strategy is kept in the product for backward
compatibility. Both these solver strategies have been shown
to be more efficient at solving models that contain several
arithmetic expressions where no table constraints are used.
However, in some cases, the DefaultDefault  strategy outperforms
these two strategies. Therefore, remember to try each
strategy.

Z3 We recommend that you use the Z3Z3  strategy as the default
solver strategy. If you're concerned about performance and
scalability, you can evaluate the other strategies.

Additional resources

NOTENOTE

Currently, there is no logic that automatically detects which solver strategy will be the most efficient strategy for

constraint-based product configuration. Therefore, you must try the solver strategies one by one.

The following table provides recommendations about the solver strategy to use in various scenarios.

Product configuration overview

Heuristics

Constraint Satisfaction Problem
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Requirements for reusing configurations

Resetting configuration reuse

NOTENOTE

You can specify that you want to automatically reuse an existing configuration for a product. Then, when a user

has completed a configuration session, the system verifies whether a configuration that matches the user ’s

selections already exists. If a matching configuration is found, the configuration ID, corresponding bill of

materials (BOM), and route are reused.

To enable configurations to be reused, you must specify the following information for the components and

attributes on the Product configuration model detailsProduct configuration model details  page:

Components and subcomponentsComponents and subcomponents  – On the GeneralGeneral  FastTab, in the Reuse configurationsReuse configurations  field, select

YesYes .

Attr ibutesAttr ibutes  – On the Attr ibutesAttr ibutes  FastTab, select the Include in reuseInclude in reuse option. This option appears only when

the related component is enabled for reuse. If you don't select any attributes for reuse, the configuration is

always reused, regardless of the user ’s selections during a configuration session. The attribute values in the

existing configuration must match the user ’s selections. For example, if the user selects BlueBlue as the color

during a configuration session, the system verifies whether an existing configuration of the component has

the color blue.

When you reset configuration reuse, previously created configurations are no longer considered. You might

want to reset configuration reuse if the BOM or route was changed, but no related attributes were changed. You

reset configuration reuse on the GeneralGeneral  FastTab for the component.
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User-defined table constraints
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Black Black

Black Metal

Oak Black

Rosewood White

White Black

White White

System-defined table constraints

This article explains the two types of table constraints for components in a product configuration model - user-

defined and system-defined. Table constraints represent matrices of the allowed attribute combinations, where

each row defines one set of possible attribute values.

Table constraints represent matrices of the combinations of attributes that are allowed for components in a

product configuration model. Each row in the table defines one set of possible attribute values. You can declare

two types of constraints in a product configuration model:

Expression constraintExpression constraint – Create an expression that defines relations between attributes to guarantee that

only compatible values can be selected during product configuration.

Table constraintTable constraint – Create a table that defines all the combinations that are allowed for a specified set of

attributes. Two types of table constraints are available: user-defined table constraints and system-defined

table constraints.

This article describes user-defined and system-defined table constraints for components in a product

configuration model.

A user-defined table constraint is a type of matrix that is used to describe the combinations of attribute values

that are defined by attribute types. For example, if you produce speakers, you can include columns for the

cabinet finish and the front grill in the user-defined table constraint. The attribute type for the cabinet finish has

four values, and the attribute type for the front grill has three values. Therefore, if constraints aren't used, there

are 4 × 3 = 12 possible combinations. However, in this example, only six combinations are allowed, as shown in

the following table. This information is displayed on the Allowed combinationsAllowed combinations  tab on the Edit tableEdit table

constraintconstraint page.

User-defined table constraints are defined by static table input that works the same way as an expression

constraint. When you use a user-defined table constraint, the advantage is that tables are often easier to create,

understand, and maintain than long expression constraints.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/system-defined-user-defined-table-constraints.md
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A system-defined table constraint creates a dynamic mapping between an attribute type and a field in a table.

When a system-defined table constraint is included in a product configuration model, the mapping guarantees

that the data in the table is shown instead of the values of the attribute type. The result is a dynamic constraint,

because the table contents can be modified (for example, by other modules).

When you create a system-defined table constraint, you select a table, optionally define the query to use, and

then associate attribute types to the fields in the selected table. The types of fields must match the types of

attribute types.

Before a table constraint can take effect on a product configuration model, the table constraint must be included

in a constraint on one of the model's components. The procedure is to create a new constraint, select the table

constraint type, and then select the table constraint definition to use. Finally, all fields in the table constraint must

be mapped to attributes in the product configuration model.

Product configuration models overview
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NOTENOTE

Constraint-based product configuration models use components as building blocks to establish the product

model structure. The components must be created before a product model can be built. The demo data

company used to create this procedure is USMF.

1. Click Product variant model definition.

2. Click Product configuration models.

3. On the Action Pane, click Model.

4. Click Components.

5. Click New.

6. In the Name field, type a value.

7. In the Description field, type a value.

8. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/create-product-model-components.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a product configuration model
2/18/2021 • 2 minutes to read • Edit Online

Create a product model

Add attributes

Add subcomponents

This procedure shows how to create a product configuration model and enter basic information such as

attributes and subcomponents. The demo data company used to create this procedure is USMF.

1. Click Product variant model definition.

2. Click Product configuration models.

3. Click New.

4. In the Name field, type a value.

5. In the Description field, type a value.

6. In the Solver strategy field, select an option.

7. In the Name field, type a value.

8. Click OK.

9. In the Reuse configurations field, select an option.

The solver strategy determines how the constraints in a constraint-based product configuration model

are processed. This selection can have an impact on the performance of the product configuration

model.

The root component represents the product configuration model, but it can also be used in other

product models.

If the reuse configurations parameter is set to Yes, the system will check for identical configurations

after each configuration session and reuse if an exact match is found.

1. Expand the Attributes section.

2. Click Add.

3. In the list, mark the selected row.

4. In the Name field, type a value.

5. In the Solver name field, type a value.

6. In the Description field, type a value.

7. In the Attribute type field, enter or select a value.

8. Select the Include in reuse check box.

The Solver name is used by the constraint solver of the product configurator. It must not include

spaces or special characters except _ (underscore).

The description text is displayed to the configuration user and can therefore serve as help in selecting

the right attribute value.

The attribute type determines which values are available for the attribute.

This option is only available when the Reuse configurations option is selected. Including the attribute

in the reuse check box means that this attribute will be considered when the system is looking for an

exact match.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/create-product-configuration-model.md
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1. Expand the Subcomponents section.

2. Click Add.

3. In the list, mark the selected row.

4. In the Name field, type a value.

5. In the Solver name field, type a value.

6. In the Description field, type a value.

7. In the Component field, enter or select a value.

8. Click Save.

9. Click BOM line details.

10. In the Item number field, enter or select a value.

11. Select the Set check box.

12. Select Yes in the Calculation field.

13. Click the Setup tab.

14. Select the Set check box.

15. In the Quantity field, enter a number.

16. Select the Set check box.

17. In the Per series field, enter a number.

18. Click OK.

Each subcomponent must reference a component definition. This design supports reusable

components and ensures that once a component has been defined it can be used in many product

models.

The BOM line details form enables the user to select the required properties for the subcomponent.

Each property can be given a fixed value or mapped to an attribute. Mapping to an attribute will result

in the BOM line property getting different values depending on the configuration selection.

Each subcomponent represents a configurable product master with constraint-based configuration

technology. The reference is made through the item number.

Setting the calculation option ensures that the product will be included when running a cost

calculation for the product.

The quantity field determines how much of this product will be consumed in the configured product.
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Create an expression constraint

Enter expression

NOTENOTE

This procedure shows how you can add a new constraint expression to a product configuration model. It shows

how you can mandate that corner protection must be applied to a speaker if the user has selected a front grill in

metal. The procedure uses the High end speaker component in the demo company USMF.

1. Click Product variant model definition.

2. Click Product configuration models.

3. In the list, find and select the desired record.

4. In the list, click the link in the selected row.

5. Expand the Constraints section.

6. Click Add.

7. Click Create.

8. In the Name field, type a value.

This example uses the high end speaker model.

1. Click Edit expression.

2. In the ConstraintBody field, enter 'Implies[FrontGrill=="Metal", CornerProtection] '.

3. Click Validate.

4. Click Close.

5. Click OK.

If you unlock the user interface in the task recording at this stage, you can use IntelliSense and the list

of symbols to build the constraint expression .

This expression logic states: If the Front grill is metal, then the corner protection option must be

selected.

The validate function runs through the constraint expression and checks for syntax errors.
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Add a calculation

Create calculation expression

NOTENOTE

This procedure shows how to add a new calculation to a product configuration model. It shows how you can

create a logical expression using the "If" operator to set a speaker height to 10 for white speakers and 15 for all

other cabinet finishes. The procedure uses the High end speaker component in the demo company USMF.

1. Click Edit expression.

2. In the ConstraintBody field, enter 'If[CabinetFinish=="White", 10, 15]'.

3. Click Validate.

4. Click Close.

5. Click OK.
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Add a BOM line

Add BOM line details

NOTENOTE

Running this procedure requires an existing product configuration model. The High end speaker model in the

demo company USMF is used to create this procedure.

1. Click Product variant model definition.

2. Click Product configuration models.

3. In the list, find and select the desired record.

4. In the list, click the link in the selected row.

5. Expand the BOM lines section.

6. Click Add.

7. In the Name field, type a value.

8. In the Description field, type a value.

9. Click Save.

Select the High end speaker for this procedure.

1. Click BOM line details.

2. In the Item number field, enter or select a value.

3. Select the Set check box.

4. Select Yes in the Calculation field.

5. Click the Setup tab.

6. Select the Set check box.

7. In the Quantity field, enter a number.

8. Click the Dimension tab.

9. Click OK.

For example, you can select the item M0055.

For each BOM line property, you can select if it takes a fixed value or is mapped to an attribute.

Setting the Calculation property to Yes ensures that the BOM line is included in cost calculations.

The quantity field determines how much of the item that will be included in the BOM. This could be an

obvious candidate for an attribute mapping.

Verify if any of the product dimensions are active, and therefore must have a value or attribute

assigned.
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The survey will take about seven minutes. No personal data is collected (privacy statement).
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Add a route operation

Enter route operation details

Running this procedure requires that a product configuration model exists. This procedure uses the High end

speaker model in the demo company USMF to walk you through the process.

1. Click Product variant model definition.

2. Click Product configuration models.

3. In the list, find and select the desired record.

4. In the list, click the link in the selected row.

5. Expand the Route operations section.

6. Click Add.

7. In the Name field, type a value.

8. In the Description field, type a value.

9. Click Save.

Select the High end speaker model for this exercise.

1. Click Route operation details.

2. In the Operation field, enter or select a value.

3. In the Oper. No. field, enter a number.

4. In the Route group field, enter or select a value.

5. Click the Setup tab.

6. Click the Times tab.

7. In the Process qty. field, enter a number.

8. In the Hours/time field, enter a number.

9. Select the Set check box.

10. In the Run time field, enter a number.

11. Click the Resource requirements tab.

12. Click Add.

13. In the list, mark the selected row.

14. In the Requirement type field, select an option.

15. In the Requirement field, enter or select a value.

16. Click OK.

Operation numbers determine the route sequence.

Each property on a route operation can get a static value or be mapped to an attribute. Mapping to an

attribute will result in the value being set as part of the configuration.

The route group determines essential behavior for costing, consumption, and setup.

Determine how many will be processed during one operation.

Enter the time ratio.

Determine the processing time for the quantity that you have specified.

Decide if you want to specify specific resources or capabilities that they must possess.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/maintain-route-product-model.md
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Set relevant product information management parameters

Build your sales price models

This topic describes how to build sales price models with sales prices based on components and attributes

rather than on the physical bill of material and the route. You can build several sales price models for each

product configuration model.

Before you start building your price models, you must define a default currency, which is used when you build

your sales price models. You can also choose whether to attach a Microsoft Excel file with a price breakdown for

all order or quotation lines. The price breakdown will enable you to share details with customers about how you

arrived at a specific sales price for a configured product.

To set your default currency:

1. Go to Product information management > Setup > Product information managementProduct information management > Setup > Product information management

parametersparameters .

2. Open the Constraint-Based product configuration modelsConstraint-Based product configuration models  tab.

3. Open the Default currencyDefault currency  drop-down list and select your currency.

4. If you'd like to attach an Excel file with a price breakdown for all order or quotation lines, then in the

Price modelPr ice model  section, set AttachAttach to Yes.

To build a sales price model:

1. Go to Product information management > Products > Product configuration modelsProduct information management > Products > Product configuration models .

2. Select the target product configuration model.

3. On the Action pane, open the ModelModel  tab and, from the Set upSet up group, select Pr ice modelsPr ice models .

4. The Pr ice modelsPr ice models  page opens.

5. Select a price model or add a new one to the grid.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/attribute-based-product-configurator.md


Add support for multiple currencies

6. Select EditEdit to open the edit page for your selected model, which provides the following features:

7. Select a node in the left column and then use the features described in the previous step to establish pricing

rules for it (see also the example provided after this procedure). Repeat this step for each node as needed.

The header of the form shows the default currency and lets you add new currencies for your price

setup.

The left pane shows all the components and user requirements of the product model. Each node in the

product model tree can have one base-price expression and an optional number of expression rules.

An expression rule consists of a condition and an expression and each expression rule covers a

product option that helps control the price of the product.

When you build your conditions and expressions, you have the same operators available as for

calculations in a product model. The expression editor also supports both conditions and expressions.

The following example shows a base price of a static number of 899.95 EUR, which can be modified by one or

more of the following five expression rules, depending on the configuration selected by the customer:

For white cabinet finish, subtract 59.95 EUR.

For corner protection, add 35.95 EUR.

For a metal front grill, add 89.95 EUR.

For rosewood cabinet finish, add 119.95 EUR.

Add 12.95 EUR for each unit of speaker height.

When a configurable product is sold, the system checks whether the prices have been set explicitly in the

currency of the customer. If so, the explicit values are used. If not, the system uses the currency exchange rates

established for the sales company to convert the default currency value to the customer's currency.

To add explicit prices in an additional currency:

1. Open the edit page for your price model, as described in Build your sales price models.

2. Select the AddAdd button in the header of the price model to open the CurrenciesCurrencies  drop-down dialog box,

which lists the available currencies.

3. Select the currency you want to add in the CurrenciesCurrencies  drop-down dialog box and then select OKOK.

4. The Current currencyCurrent currency  drop-down list now includes the currency that you just added, plus any other

currencies that may have been added previously. Select your new currency and notice that the grid in the

Expression rulesExpression rules  section now includes two expression fields:



NOTENOTE

Test your price model

NOTENOTE

ExpressionExpression - Shows the expression (or constant value) for finding the price using the currency

currently selected for Current currencyCurrent currency .

Default expressionsDefault expressions  - Shows the expression (or constant value) for finding the price using the

default currently (shown in the Default currencyDefault currency  field).

The ConditionCondition field for the expression rules is "owned" by the default currency, which means that you can't

modify the condition for other currencies. You also can't add new expression rules while a currency other than the

default currency is selected as the Current currencyCurrent currency .

5. Edit values in the ExpressionExpression column as needed for the current currency.

In the example below, EUR is the default currency, and USD has been added as an additional currency.

You can't add expression rules that are unique for a non-default currency. To create expression rules that would be

relevant only for a currency other than the default currency, set the price expression for the default currency to zero. Then

set the appropriate expression for the non-default currency.

To test how the sales prices work in a configuration session, open the edit page for your price model, as

described in Build your sales price models and then select TestTest on the Action Pane. The Test product modelTest product model

dialog box opens, where you can do the following:

Use the configuration settings offered here to select product options and then see how they affect the value

shown for Pr ice and ship datePrice and ship date.

Select View price breakdownView price breakdown to download an Excel document that shows full details about how the price

was calculated.



Set up selection criteria for price models

The downloaded spreadsheet shows both the absolute value and the contribution as a percentage for each

active price element. If you have set the AttachAttach price model option on the Product informationProduct information

management parametersmanagement parameters  page, this Excel sheet gets attached to the order or quotation line.

When your price models are in place, you must establish at least one selection criterion to pick up the price

model when you configure to quote or to order. You'll do this by setting up one or more queries. In a

combination with matching sales price models, the queries provide great flexibility in targeting sales prices for

particular customers, regions, periods, and other criteria.

To set up selection criteria for price models:

1. Go to Product information management > Products > Product configuration modelsProduct information management > Products > Product configuration models .

2. Select the target product configuration model.

3. On the Action pane, open the ModelModel  tab and, from the Set upSet up group, select Pr ice model cr iter iaPr ice model cr iter ia . The

Price model cr iter iaPr ice model cr iter ia page opens.

4. If the query row you need doesn't exist yet, select NewNew  on the Action Pane to add a new row to the grid

and make the following settings for it:



Set attribute-based sales prices for the product model version

TIPTIP

IMPORTANTIMPORTANT

NameName - Enter a name for this row.

Descr iptionDescr iption - Briefly describe the query and what it is for.

Pr ice modelPr ice model  - Select a price model (from the current configuration model) that the query will apply

when triggered.

Order typeOrder type - Select the type of order where the query will apply.

Valid fromValid from - Specify the first day when the query will apply.

Expire byExpire by  - Specify the last date when the query will apply.

5. Select the row for the query you want to define and then select EditEdit on the Action PaneAction Pane. The query

designer dialog box opens. It works like most query designers in Supply Chain Management. Use it to

define the conditions under which the price model for the row you selected should be applied.

6. Repeat steps 4-5 for each query you require.

You can save time by copying an existing row that is already similar to a new one that you need to add. To do this,

select a target row and then select DuplicateDuplicate on the Action Pane.

7. When you have finished setting up your criteria, arrange them into the proper order in the Pr ice modelPr ice model

cr iter iacr iter ia list. To reposition a row, select the row and then select UpUp or DownDown on the Action Pane.

At configuration time, the system starts searching from the top of the list and uses the first query that matches

the data on the quote or the order line. Therefore, you must put your most specific queries on top. If you place a

general query at the top of the list, this is the one that will be used even though there might be a query further

down the list that targets the exact customer or prospect of the configuration.

The final step is to specify attribute-based sales prices for the product model version. To do this:

1. Go to Product information management > Products > Product configuration modelsProduct information management > Products > Product configuration models .

2. Select the target product configuration model.

3. On the Action Pane, open the ModelModel  tab and, from the Product model detailsProduct model details  group, select VersionsVersions .

4. The VersionsVersions  page opens. Make sure the Pr icing methodPricing method is set to Attr ibute basedAttr ibute based. 
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Running this procedure requires that at least one product configuration model is available. This procedure uses

the High end speaker model in the demo data company USMF. Note that this model has already been approved,

but the procedure walks you through the entire process.

1. Click Product variant model definition.

2. Click Product configuration models.

3. In the list, find and select the desired record.

4. Click Versions.

5. Click New.

6. In the Product number field, enter or select a value.

7. In the From date field, enter a date.

8. In the To date field, enter a date.

9. Click Approve to open the drop dialog.

10. In the Approved by field, enter or select a value.

11. Click OK.

12. In the Pricing method field, select an option.

13. Close the page.

Select the High end speaker model for this procedure.

The reference to a product represents a version of a product configuration model. Only product

masters which have the constraint-based configuration technology will appear in this list.

Select when the product model version will be available.

Select an end date when this product model version will expire, or select Never.

Select the person who is responsible for approving product models for use in operations.

Activate the product model version. It is only possible to have one product active for one product

model at a time.
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The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/approve-product-configuration-model.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Transfer data for product models
2/18/2021 • 2 minutes to read • Edit Online

NOTENOTE

Exporting data for a product configuration model requires that you have at least one product model available.

This procedure uses the High end speaker model in the demo company USMF to show you how to export data

for this model.

1. Click Product variant model definition.

2. Click Product configuration models.

3. In the list, find and select the desired record.

4. On the Action Pane, click Model.

5. Click Export product model.

Select the High end speaker model for this procedure.

The download behavior varies from browser to browser depending on how the security settings are

set up.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Item text is overwritten when I configure a product on a sales order
line.
Issue descriptionIssue description

Issue resolutionIssue resolution

Integer attributes are incorrectly rounded when product
configuration models are calculated.
Issue descriptionIssue description

Issue resolutionIssue resolution

This topic describes how to fix issues that you might encounter while you work with the product configurator.

This issue occurs when you create a sales order line for a configurable item and then modify the item text. When

you configure the item and then select OKOK, the text is overwritten with the standard text.

This behavior is expected. The text field includes the variant name, which is filled in only after you configure the

line. Therefore, you must change the text after you've configured the line, not before.

This issue can occur when you perform the following series of actions:

1. Set up the following attributes on a production configuration model:

Input (integer)

Percent (decimal)

Result (integer)

2. Create a calculation that has the following expression:

Result = Input × Percent ÷ 100

In this case, the integer result isn't always correctly rounded. For example, the input is 1,000, and the percentage

is 2.40. Therefore, you expect the integer result to be 24, because 2.40 percent of 1,000 is 24 (or 24.00 in

decimal form). Instead, the result is shown as 23. However, when the percentage is 2.39, the calculation is

rounded to 24 instead of 23. When the percentage is 2.50, the calculation is rounded to 25, as expected.

This issue occurs because of the way that Microsoft Solver Foundation internally represents numbers by using

fractions. For the preceding example, the result of the calculation where the percentage is 2.40 is represented as

27021597764222975 ÷ 1125899906842624 =

23.99999999999999911182158029987476766109466552734375. When .NET casts this value as an integer, it

will return 23.

This behavior won't be changed, because other scenarios depend on it. For the preceding example, you can fix

the issue by introducing an additional decimal attribute and a calculation.

For example, you can set up the following attributes on a production configuration model:

Input (integer)

Percent (decimal)

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/troubleshooting-productconfigurator.md
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ResultDecimal (decimal)

ResultInteger (integer)

You can then add the following calculations:

ResultDecimal = Input × Percent ÷ 100

ResultInteger = ResultDecimal
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Feature summary

Turn on the engineering change management and version dimension
features for your system

Today'smanufacturers require strong product data management, version control, and engineering change

management to succeed in a world ofconstantly shrinking product lifecycles, increased quality and reliability

requirements, and an increased focus on product safety.

Engineering change management brings structure and discipline to the product data management process, and

enables products tobe defined, released,and revised in a controlled manner that is supported by

workflows.Through product versions and engineeringchangemanagement, you candocument,assessthe impact

of,andapplyengineering changes throughout the whole lifecycle of a product.

Engineering change management helps you plan and manage product versioning, and manage product

lifecycles and engineering changes. Here is a list of its main features:

Product versioning

Enhanced product release functionality that lets you maintain product master data in one legal entity (the

engineering company) and publish the fully configured released product to other legal entities

Rules for validating that required information is entered before a product version is activated (readiness

checks)

Improved product lifecycle management through fine-grained control over when a released product can be

used in specific business processes

Engineering change requests that are supported by workflows

Engineering change orders that are supported by workflows

The preceding video (Change management capabilities in Dynamics 365 Supply Chain Management) is included

in the Finance and Operations playlist available on YouTube.

Before you can use engineering change management, you must enable both the Engineering Change

Management feature and its configuration key. If you also want to track the version dimension of products in

transactions (optional), then you must also enable the Product version dimension feature and its configuration

key.

First, turn on the features by following these steps.

1. Go to Feature management.

2. Check for updates.

3. Turn on the feature that is named Engineering Change ManagementEngineering Change Management.

4. If you want to use it, then also turn on the feature that is named Product dimension versionProduct dimension version.

Next, turn on the configuration keys by following these steps.

1. Put your system into maintenance mode, as described in Maintenance mode.

2. Go to System administration > Setup > L icense configurationSystem administration > Setup > L icense configuration.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/engineering-change-management/product-engineering-overview.md
https://www.microsoft.com/en-us/videoplayer/embed/RE4HE6B
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https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/sysadmin/maintenance-mode
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3. Expand the TradeTrade node

4. Select the Engineering Change ManagementEngineering Change Management check box.

5. If you want to use it, then also select the Product dimension - VersionProduct dimension - Version check box.

6. Turn off maintenance mode, as described in Maintenance mode.
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Set up for the sample scenario

Make standard demo data availableMake standard demo data available

Set up an engineering organizationSet up an engineering organization

This topic provides an end-to-end walkthrough that shows how to work with engineering change management.

It goes through each of the most important scenarios:

Basic feature configuration

How an engineering company creates a new engineering product

How an engineering company releases an engineering product to a local company

How a local company can review and accept a product that has been released to it by an engineering

company

How a local company can use an engineering product in standard transactions

How to add an engineering product to a sales order

How to request changes to an engineering product by creating an engineering change request

How to schedule and implement requested changes by creating an engineering change order

How to release a product that has been changed

All the exercises in this topic use the standard sample data that is provided for Microsoft Dynamics 365 Supply

Chain Management. Additionally, each exercise builds on the previous exercise. Therefore, we recommend that

you work through the exercises in order, from beginning to end, especially if you've never used the engineering

change management feature before. In this way, you will gain a complete understanding of the feature.

To follow the sample scenario that is provided in this topic, you must first prepare the feature by making demo

data available and adding a few custom records.

Before you try to do any of the exercises in the rest of this topic, follow the instructions in all the following

subsections. These subsections also introduce several important settings pages that you will use when you set

up engineering change management for your own organization.

Work on a system where the standard demo data is installed. The standard demo data adds data for several

demo legal entities (companies and organizations). As you work through the exercises, you will use the

company picker on the right side of the navigation bar to switch between one company (DEMF) that is set up as

an engineering organization and another company (USMF) that is set up as an operational organization.

An engineering organization owns the engineering data, and is responsible for product design and product

changes. To set up your engineering organizations, follow these steps.

1. Go to Engineering change management > Setup > Engineering organizationsEngineering change management > Setup > Engineering organizations .

2. Select NewNew  to add a row to the grid, and set the following values for it:

Engineering organization:Engineering organization: DEMF

Organization name:Organization name: Contoso Entertainment System Germany

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/engineering-change-management/engineering-scenarios.md


Set up the version product dimension groupSet up the version product dimension group

Set up product lifecycle statesSet up product lifecycle states

1. Go to Product information management > Setup > Dimensions and var iant groups > ProductProduct information management > Setup > Dimensions and var iant groups > Product

dimension groupsdimension groups .

2. Select NewNew  to create a product dimension group.

3. Set the NameName field to Version.

4. Select SaveSave to save the new dimension and load values onto the Product dimensionsProduct dimensions  FastTab.

5. On the Product dimensionsProduct dimensions  FastTab, set VersionVersion as an active product dimension.

As an engineering product goes through its lifecycle, it's important that you be able to control which

transactions are allowed for each lifecycle state. To set up the product lifecycle states, follow these steps.

1. Go to Engineering change management > Setup > Product lifecycle stateEngineering change management > Setup > Product lifecycle state.

2. Select NewNew  to add a lifecycle state, and set the following values for it:

State:State: Operational

Descr iption:Descr iption: Operational

3. Select SaveSave to save the new lifecycle state and load values onto the Enabled business processesEnabled business processes

FastTab.

4. On the Enabled business processesEnabled business processes  FastTab, select the business processes that should be available. For

this example, leave the PolicyPolicy  field set to Enabled for all business processes.



Set up a version number ruleSet up a version number rule

5. Select NewNew  to add another lifecycle state, and set the following values for it:

State:State: Prototype

Descr iption:Descr iption: Prototype

6. Select SaveSave to save the new lifecycle state and load values onto the Enabled business processesEnabled business processes

FastTab.

7. On the Enabled business processesEnabled business processes  FastTab, select the business processes that should be available. For

this example, set the PolicyPolicy  field to Enabled with warning for all business processes.



Set up a product release policySet up a product release policy

1. Go to Engineering change management > Setup > Product version number ruleEngineering change management > Setup > Product version number rule.

2. Select NewNew  to add a rule, and set the following values for it:

Name:Name: Auto

Number rule:Number rule: Auto

Format:Format: V-##

1. Go to Engineering change management > Setup > Product release policiesEngineering change management > Setup > Product release policies .

2. Select NewNew  to add a release policy, and set the following values for it:

Name:Name: Components

Descr iption:Descr iption: Components

3. On the GeneralGeneral  FastTab, set the following values:

Product type:Product type: Item

Apply templates:Apply templates: Always

Active:Active: Yes

4. On the All productsAll products  FastTab, select AddAdd to add a line, and set the following values for it:

Company:Company: DEMF

Template released product:Template released product: D0006

5. Select AddAdd to add another line, and set the following values for it:

Company accounts ID:Company accounts ID: USMF

Template released product:Template released product: D0006

Receive BOM:Receive BOM: Select this check box.

Copy BOM approval:Copy BOM approval: Select this check box.

Copy BOM activation:Copy BOM activation: Select this check box.

Receive route:Receive route: Select this check box.

Copy route approval:Copy route approval: Select this check box.

Copy route activation:Copy route activation: Select this check box.



Set up an engineering product categorySet up an engineering product category

Set up product acceptance conditionsSet up product acceptance conditions

Engineering product categories provide the basis for creating engineering products (that is, products that are

versioned and controlled through engineering change management). To set up engineering product categories,

follow these steps.

1. Go to Engineering change management > Engineering product categor y detailsEngineering change management > Engineering product categor y details .

2. Select NewNew  to create a category.

3. On the DetailsDetails  FastTab, set the following values:

Name:Name: Components

Engineering organization:Engineering organization: DEMF

Product type:Product type: Item

Track version in transactions:Track version in transactions: Yes

Product dimension group:Product dimension group: Version

Product lifecycle state at creation:Product lifecycle state at creation: Operational

Version number rule:Version number rule: Auto

Enforce effectivity:Enforce effectivity: No

Use number rule nomenclature:Use number rule nomenclature: No

Use name rule nomenclature:Use name rule nomenclature: No

Use descr iption rule nomenclature:Use descr iption rule nomenclature: No

4. On the Release policyRelease policy  FastTab, set the Product release policyProduct release policy  field to Components.

5. Select SaveSave.

1. Use the company picker on the right side of the navigation bar to switch to the USMF legal entity

(company).

2. Go to Engineering change management > Setup > Engineering change managementEngineering change management > Setup > Engineering change management

parametersparameters .

3. On the Release controlRelease control  tab, in the Product acceptanceProduct acceptance section, set the Product acceptanceProduct acceptance field to

Manual.



Create a new engineering product
An engineering product is a product that is versioned and controlled through engineering change management.

In other words, you can control the changes during its life, and the change information will be saved using

engineering change orders. To create engineering products, follow these steps.

1. Make sure that you're in the legal entity of your engineering organization (DEMF for this example). Use

the company picker on the right side of the navigation bar as required.

2. Open the Released productsReleased products  page by following one of these steps:

Go to Product information management > Products > Released productsProduct information management > Products > Released products .

Go to Engineering change management > Common > Released productsEngineering change management > Common > Released products .

3. On the Action Pane, on the ProductProduct tab, in the NewNew  group, select Engineering productEngineering product.

4. In the New productNew product dialog box, set the following values:

Engineering Product Categor y:Engineering Product Categor y: Components

Product number :Product number : Z0001

Product name:Product name: Speaker set

Note that the VersionVersion field is automatically set by using the product version number rule that you set up

earlier.



5. Select OKOK to create the product and close the dialog box.

6. The details page for the new product is opened. Notice that values are already filled in for some fields,

such as Storage dimension groupStorage dimension group, Tracking dimension groupTracking dimension group, and/or Item model groupItem model group. These

fields were automatically set because the product is being released in the DEMF legal entity and uses the

Components product release policy, which is associated with the Components engineering product

category. Because you previously used item D0006 as a template to set up a line for the DEMF legal

entity, the values that were filled in were taken from item D0006.

7. On the Action Pane, on the EngineerEngineer  tab, in the Engineering change managementEngineering change management group, select

Engineering versionsEngineering versions  to view the versions of the product.

8. On the Engineering versionsEngineering versions  page, notice that there is only one version for the product, and it's active.

9. Select the version to view its details.

10. On the Engineering versionEngineering version page, on the Bill of mater ialBill of mater ial  FastTab, select Create BOMCreate BOM.

11. In the Create BOMCreate BOM dialog box, set the following values:

BOM number :BOM number : Z0001



Name:Name: Speaker set

S ite:S ite: 1

12. Select OKOK to add the BOM and close the dialog box.

13. On the Bill of mater ialsBill of mater ials  FastTab, select Bill of mater ialBill of mater ial .

14. On the Bill of mater ialsBill of mater ials  page, on the Bill of mater ials linesBill of mater ials lines  FastTab, add three lines, one each for item

numbers D0001, D0003, andD0006.

15. Select SaveSave.

16. Close the page.

17. On the Engineering versionEngineering version page, on the Bill of mater ialBill of mater ial  FastTab, select ApproveApprove.

18. In the dialog box that appears, select OKOK.



 Release an engineering product to a local company

19. On the Engineering versionEngineering version page, on the Bill of mater ialBill of mater ial  FastTab, select ActivateActivate.

20. Notice that the ActiveActive and ApprovedApproved check boxes are selected for the BOM.

21. Close the page.

The product has now been designed by the Engineering department. For this example, the product is a

prototype that engineering has designed for a customer. Because the customer is a customer of the USMF legal

entity, the product must be released to that legal entity.

1. Keep the legal entity set to DEMF. (Use the company picker on the right side of the navigation bar as

required.)

2. Go to Product information management > Products > Released productsProduct information management > Products > Released products .

3. Select product Z0001.

4. On the Action Pane, on the ProductProduct tab, in the MaintainMaintain group, select Release product structureRelease product structure to

open the Release productsRelease products  wizard.

5. On the Select engineering products to releaseSelect engineering products to release page, select the SelectSelect check box for product Z0001.



6. Select Release detailsRelease details .

7. The Product release detailsProduct release details  page appears, where you can review the details of the product that will be

released, and its product structure. Notice that the Send BOMSend BOM option is set to Yes. Therefore, both

product Z0001 and all its child items from the BOM will be released.

You can select any child item in the left pane to review its details. If any child item has a BOM, you can

also select to release the BOM of that child item.

8. Close the page to return to the Release productsRelease products  wizard.

9. Select NextNext to open the Select products to releaseSelect products to release page. If you had selected any standard (non-

engineering) products, they would appear on this page. Note that when you release a standard product

by selecting Release product structureRelease product structure, its BOM and route are also released.



  Review and accept the product before you release it in the local
company

10. Select NextNext to open the Select product var iants to releaseSelect product var iants to release page. For this example, there aren't any

variants.

11. Select NextNext to open the Select companiesSelect companies  page.

12. Select the companies that the product should be released to. For this example, select the check box for

USMFUSMF.

13. Select NextNext to open the Confirm selectionConfirm selection page.

14. Select FinishFinish .

The Engineering department has now released the information to the local companies where the product will be

used. For this example, the local company is USMF.

Because you set the Product acceptanceProduct acceptance field to Manual on the Engineering change managementEngineering change management

parametersparameters  page for the USMF company, products must be manually accepted before they are released to that

company. In other words, they must be reviewed and accepted before they become released products.

To review the product and release it in the USMF company, follow these steps.

1. Set the legal entity to USMF. (Use the company picker on the right side of the navigation bar.)



Use the product in transactions in the local company

2. Go to Engineering change management > Common > Product releases > Open productEngineering change management > Common > Product releases > Open product

releasesreleases .

The Open product releasesOpen product releases  page shows product Z0001, which has a status of Pending acceptance.

3. Select the value in the Product numberProduct number  column to open the Product release detailsProduct release details  page. Notice the

following details:

The GeneralGeneral  FastTab shows information about the product release, such as the releasing company

(DEMF for this example), the releasing site (1), and the receiving site (1). Because you didn't specify a

receiving site in the Release productsRelease products  wizard, the the releasing site value is copied to the receiving

site.

The Release detailsRelease details  FastTab shows information about the product and the version that was released.

Here, you can modify settings such as the effectivity dates.

The RouteRoute FastTab shows the route of the product. However, for this example, you didn't release any

routes.

4. When you've finished reviewing the information, you're ready to accept the product and, in this way,

release it in the USMF company. On the Action Pane, select Actions > AcceptActions > Accept.

5. The product is now released in the USMF company. Go to Product information managementProduct information management

>Products > Released products>Products > Released products . You should see item Z0001.

The master data manager for the USMF company wants to make sure that the product is in a Prototype state, to

ensure that users will be warned if they accidentally add it to processes that they are working on.

1. Go to Product information management > Products > Released productsProduct information management > Products > Released products .

2. Select product Z0001 to open its details page. (You can use the filter to find the product.)



Add the engineering product to a sales order

Request changes in the engineering product

3. On the Action Pane, on the EngineerEngineer  tab, in the Engineering change managementEngineering change management group, select

Engineering versionsEngineering versions .

4. On the Engineering versionsEngineering versions  page, select version number V-01 to open its details page.

5. On the Action Pane, on the ProductProduct tab, in the L ifecycle stateLifecycle state group, select Change lifecycle stateChange lifecycle state.

6. In the Change lifecycle stateChange lifecycle state drop-down dialog box, set the StateState field to Prototype, and then select

OKOK.

The product can now be sold to a customer. To add the product to a sales order, follow these steps.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. On the Action Pane, select NewNew .

3. In the Create sales orderCreate sales order  dialog box, set the Customer accountCustomer account field to US-0002, and then select OKOK.

4. The new sales order is opened. On the Sales order linesSales order lines  FastTab, add a row, and set the Item numberItem number

field to Z000 for it.

5. On the Action Pane, select SaveSave.

You receive a warning message that informs you that the item has a status of Prototype. However,

because the message is just a warning, the sales order was still created.

The product was sent to a customer, but the customer wasn't completely satisfied and provides feedback that

includes suggestions for improvement. While the customer is speaking with a sales clerk on the phone, the sales

clerk can request the changes that the customer is describing.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .



Make changes to the product by using an engineering change order

2. Find and open the sales order that you created in the previous exercise.

3. On the Sales order linesSales order lines  FastTab, select Engineering change management > New engineeringEngineering change management > New engineering

change requestchange request.

4. Fill in the engineering change request, based on the customer's feedback. For this example, set the

following values:

Change request:Change request: 555

Title:Title: Z0001 customer change

Prior ity:Pr ior ity: low

Categor y:Categor y: set change

Severity:Severity: Medium

5. On the InformationInformation FastTab, select New > NoteNew > Note to add a note to the grid.

6. In the Descr iptionDescr iption field for the new note, indicate that item D0003 should be deleted from the BOM. If

you must add more information for the note, you can enter text in the NotesNotes  field.

7. On the Action Pane, select SaveSave.

8. Notice that the item has automatically been added on the ProductsProducts  FastTab, and that the source of the

engineering change request (the sales order) has been added on the SourceSource FastTab.

The sales clerk knows that the product is important and was designed especially for the customer. Therefore, the

sales clerk calls an engineer in the DEMF company to notify them about the change request. In this way, the

engineer can speed up the process.

The engineer now reviews the request from the customer and creates a change order for the product.



1. Because the engineer works in the DEMF company, set the legal entity to DEMF. (Use the company picker

on the right side of the navigation bar.)

2. Go to Engineering change management > Common > Engineering change requestsEngineering change management > Common > Engineering change requests .

3. Open change request 555.

4. Review the information, and then approve the change. On the Action Pane, on the Change requestChange request tab,

in the Change statusChange status  group, select ApproveApprove.

5. Go to Engineering change management > Common > Engineering change ordersEngineering change management > Common > Engineering change orders .

6. On the Action Pane, select NewNew  to create a change order, and set the following values for it:

Change order :Change order : 555

Title:Title: Z0001 customer change

Categor y:Categor y: Customer change

Prior ity:Pr ior ity: Low

Severity:Severity: Medium

7. On the Impacted productsImpacted products  FastTab, select New > Add existing productNew > Add existing product to add a row to the grid, and

set the following values for it:

Product:Product: Z0001

Impact:Impact: New version

8. Notice that, because you set the ImpactImpact field to New version, the New versionNew version field on the DetailsDetails  tab

of the Product detailsProduct details  FastTab shows what the new version number will be (V-02 for this example).

9. On the Action Pane, select SaveSave.

10. On the Product detailsProduct details  FastTab, on the Bill of mater ialBill of mater ial  tab, select L inesLines  to open the BOM for version

V-01 of product Z0001.



Release the changed product

11. Select the line for item number D0003, and then, on the Action Pane, select DeleteDelete. The value of the

Change typeChange type field for this line changes to Deleted.

12. On the Action Pane, select SaveSave.

13. Close the BOM lineBOM line page to return to the Engineering change orderEngineering change order  page.

14. On the Product detailsProduct details  FastTab, on the Bill of mater ialBill of mater ial  tab, notice that the value of the Change typeChange type

field for BOM Z0001 is now Changed.

The order must now be approved before the changes can be processed. When the changes are processed,

the products are updated with the changes that are included in the engineering change order. For this

example, the person who creates the engineering change order has been specified as the approver.

15. On the Action Pane, on the Change orderChange order  tab, in the Change statusChange status  group, select ApproveApprove.

16. Select ProcessProcess  to update the product's information.

17. Select CompleteComplete to mark the change order as completed.

The product can now be released again to the USMF company and then sent to the customer. To release the

product directly from the engineering change order, follow these steps.

1. Open the engineering change order that you created in the previous exercise, if it isn't already open.

2. On the Action Pane, on the Change orderChange order  tab, in the Product releasesProduct releases  group, select SearchSearch.

3. The search results show which companies the affected products have been released to. Close the search

results.

4. On the Action Pane, on the Change orderChange order  tab, in the Product releasesProduct releases  group, select ViewView  to open the

ReleasesReleases  dialog box, where you can view the results of the previous search.

5. Select each company that you want to release products to.

6. Select OKOK to close the ReleasesReleases  dialog box and return to the change order.



NOTENOTE

7. On the Action Pane, on the Change orderChange order  tab, in the Product releasesProduct releases  group, select ProcessProcess  to release the

affected products to the selected companies. Alternatively, select Release product structureRelease product structure to start the

release process.
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Open the Engineering change management parameters page

Release control tab

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Item number rule Select how the item number should be defined when the
product is released to a legal entity. Select Engineering
product number if the product number in the receiving legal
entity should match the product number in the engineering
company. Select Local item number sequence if the product
should take the next number in the number sequence for
product numbers in the receiving legal entity.

BOM name rule Select how the name of the bill of materials (BOM) is defined
when the product is received (released) in a legal entity.
Select either Engineering name or Receiving item number.

Route name rule Select how the route name should be defined when the
route of a product is received (released) in a legal entity.
Select either Engineering name or Receiving item number.

Run BOM check Select whether a BOM check will be run when the product is
received (released) in a legal entity.

Release behavior of inactive BOM Select whether a product can be released if it has an inactive
BOM. Select Accept, Warning only, or Not allowed.

Release behavior of inactive route Select whether a product can be released if it has an inactive
route. Select Accept, Warning only, or Not allowed.

Product acceptance Select whether an additional step for acceptance is required
before the product can be released in the legal entity. Select
Manual to add the acceptance step. In this case, the OpenOpen
product releasesproduct releases page will show the products. Select
Automatic to show the product directly on the ReleasedReleased
productsproducts  page in the target legal entity immediately after
the product is released together with its release product
structure.

The Engineering change management parametersEngineering change management parameters  page contains setup parameters that change the default

behavior that is related to the release product structure and engineering change management processes.

To open the Engineering change management parametersEngineering change management parameters  page, go to Engineering changeEngineering change

management > Setup > Engineering change management parametersmanagement > Setup > Engineering change management parameters . You can then set the fields as

described in the remaining sections of this topic.

The following table describes the fields that are available on the Release controlRelease control  tab of the EngineeringEngineering

change management parameterschange management parameters  page. These fields affect the release product structure process.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/engineering-change-management/engineering-parameters.md


Engineering change management tab

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Category The default category that will be used when an engineering
change request is created.

Priority The default priority that will be used when an engineering
change request is created.

Severity rule Select how the severity of an engineering change order
should be established. Select Manual if the user is expected
to enter a value in the SeveritySeverity  field. Select Calculate to
have the system calculate the value of the SeveritySeverity  field
when you select Calculate severityCalculate severity  on the Action Pane of
the engineering change order. In this case, the system will
use the severity rules that are defined on the Severity ruleSeverity rule
setset  page. Select Calculate automatically to have the value of
the SeveritySeverity  field automatically calculated and filled in
according to the severity rule sets.

Re-release impacted products This field is applicable when you re-release products via an
engineering change order. You can select whether all
products or only the affected products should be proposed
in the ReleasesReleases dialog box.

BOM levels to release The depth of the BOM level to release. If the BOM has more
levels (that is, if it's deeper) than the value that is specified
here, only the levels up through the specified value will be
released.

NOTENOTE

The following table describes the fields that are available on the Engineering change managementEngineering change management tab of the

Engineering change management parametersEngineering change management parameters  page. These settings affect the engineering change

management process.
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Engineering change categories

Engineering change priorities

Engineering change reasons

Material disposal codes

When you set up engineering change management, you must establish several collections of values that will be

used to fill in drop-down lists in other parts of the user interface (UI). You should specify these values according

to the types of products that you produce and your specific business needs.

You use engineering change categories to organize your engineering change orders, so that they are easier to

manage and review. For example, you might find it useful to set up a workflow where, depending on the

category, a specific department must review the proposed changes. Therefore, the engineering change order

includes a Categor yCategor y  field.

To establish the collection of engineering change categories that is used in your company, go to EngineeringEngineering

change management > Setup > Engineering change management > Engineering changechange management > Setup > Engineering change management > Engineering change

categoriescategories . You can then use the buttons on the Action Pane to add, remove, and edit values, and to arrange

them into the order in which they should appear in the drop-down lists where they are shown.

You use engineering change priorities to indicate the importance or urgency of an engineering change order.

They can help you keep track of the importance of an engineering change order, so that you can easily identify

which orders should be processed first, and how quickly.

To establish the collection of engineering change priorities that is used in your company, go to EngineeringEngineering

change management > Setup > Engineering change management > Engineering change prior itieschange management > Setup > Engineering change management > Engineering change prior ities .

You can then use the buttons on the Action Pane to add, remove, and edit values, and to arrange them into the

order in which they should appear in the drop-down lists where they are shown.

Engineering change reasons indicate the cause or nature of the change in the change order.

To establish the collection of engineering change reasons that is used in your company, go to EngineeringEngineering

change management > Setup > Engineering change management > Engineering change reasonschange management > Setup > Engineering change management > Engineering change reasons .

You can then use the buttons on the Action Pane to add, remove, and edit values, and to arrange them into the

order in which they should appear in the drop-down lists where they are shown.

You use material disposal codes to categorize materials that are used in your finished goods, or components

that must be disposed of in a specific way or require some treatment before they can be added to your regular

trash. When you add a relevant product to an engineering change order, you can assign a disposal code as part

of the change details.

To establish the collection of material disposal codes that is used in your company, go to Engineering changeEngineering change

management > Setup > Engineering change management > Mater ial disposal codesmanagement > Setup > Engineering change management > Mater ial disposal codes . You can then

use the buttons on the Action Pane to add, remove, and edit values, and to arrange them into the order in which

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/engineering-change-management/engineering-change-management-setup.md


Received customer approval

Engineering change – Environmental health and safety codes

Engineering change severities

Engineering change severity rule sets

they should appear in the drop-down lists where they are shown.

When you design products for a specific customer, the design and specifications often must be validated before

the product can be set as ready. The Received customer approvalReceived customer approval  field lets you indicate how far in the

customer approval process the product is and/or whether the approval has been received.

To establish the collection of received customer approval values that is used in your company, go to

Engineering change management > Setup > Engineering change management > ReceivedEngineering change management > Setup > Engineering change management > Received

customer approvalcustomer approval . You can then use the buttons on the Action Pane to add, remove, and edit values, and to

arrange them into the order in which they should appear in the drop-down lists where they are shown.

If any standard environmental health and safety regulations, or company-specific regulations or procedures,

must be considered in the manufacture of a product, you can use the environmental health and safety codes to

define them. In the engineering change order, you can indicate which codes apply to the manufacture of a

product while you edit the details of the affected product.

To establish the collection of health and safety values that is used in your company, go to Engineering changeEngineering change

management > Setup > Engineering change management > Engineering change - Environmentalmanagement > Setup > Engineering change management > Engineering change - Environmental

health and safety codeshealth and safety codes . You can then use the buttons on the Action Pane to add, remove, and edit values,

and to arrange them into the order in which they should appear in the drop-down lists where they are shown.

You use engineering change severities to indicate the level of impact that applies to the products in an

engineering change order.

To establish the collection of engineering change severities that is used in your company, go to EngineeringEngineering

change management > Setup > Engineering change management > Engineering change severitieschange management > Setup > Engineering change management > Engineering change severities .

You can then use the buttons on the Action Pane to add, remove, and edit values, and to arrange them into the

order in which they should appear in the drop-down lists where they are shown.

You can establish rules that apply to each severity level that you create. For more information about how to

assign these rules, see the next section.

You use engineering change severity rule sets to establish a group of rules that you can use to automatically

calculate the severity of the change order, based on the type of changes in the affected products. To use the

severity rules, open the Engineering change management parametersEngineering change management parameters  page, and set the Severity ruleSeverity rule

field to Calculate or Calculate automatically.

When the system evaluates severity, it processes the rules in the order in which they appear on the page, from

top to bottom. For a rule to be selected and have its priority established, all the rules in a rule set must be met.

To set up the rules that apply to each change severity level that you've defined, go to Engineering changeEngineering change

management > Setup > Engineering change management > Engineering change severity rule setsmanagement > Setup > Engineering change management > Engineering change severity rule sets .

Then follow one of these steps.

To create a new rule set, select NewNew  on the Action Pane, and then set the fields as described later in this

section.

To edit an existing rule set, select it in the list pane, select EditEdit on the Action Pane, and then set the fields as

described later in this section.



NOTENOTE

To delete an existing rule set, select it in the list pane, and then select DeleteDelete on the Action Pane.

To rearrange the list of rule sets, select a rule set in the list pane, and then use the UpUp and DownDown buttons on

the Action Pane to reposition it.

For each rule set, set the following field:

SeveritySeverity  – Select the severity level to establish rules for. You use the Engineering change severitiesEngineering change severities  page

to create and name the levels. (For more information, see the previous section.)

Use the buttons on the RulesRules  FastTab to add or remove a rule for the current severity setting. Each rule has a

RuleRule field and a NameName field. The rules are established by the system and indicate the types of changes that a

product can have. The name indicates the type of change.
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Engineering companies and operational companies

Engineering product categories and engineering companies

Data that is owned by the engineering company

To ensure that the master data for products is centrally created and maintained, you can use one or more

engineering companies. An engineering company owns the engineering products and their engineering-

relevant data. It's always connected to (based on) an existing legal entity, which is also a company. Through this

connection, the system establishes a central entry point for all engineering-relevant data for engineering

products in the engineering company. In this central entry point, engineering products are created, and

engineering-relevant data is maintained. From it, the engineering products and engineering-relevant data will

be released to operational companies, which are other legal entities. (For more information about the release

management, see Release product structures.) These operational companies will use the engineering data as it

has been designed by the engineering company. Any logistical data is locally maintained by each engineering

company and operational company.

To create an engineering company, go to Engineering change management > Setup > EngineeringEngineering change management > Setup > Engineering

organizationsorganizations . Select NewNew , enter a name for the engineering company, and select the existing company (legal

entity) that it's based on.

If you're integrating with external product lifecycle management (PLM) systems, you must create a business unit

(type of company) that will become an external company.

Engineering product categories help ensure that engineering products are created according to your company's

business rules and behave as required. For more information about engineering product categories, see

Engineering versions and engineering product categories.

Each engineering product category belongs to a specific engineering company and can create only products that

belong to that company. Likewise, the right to maintain an engineering product also belongs to the company

that is associated with that product's engineering product category.

Because the engineering company owns the engineering-relevant data, it controls the following processes:

Creation of engineering products:Creation of engineering products: Each engineering company can only create new engineering

products that are based on an engineering product category that it owns. In some cases, operational

companies maintain their own local data that is related to those products.

Creation of engineering versions:Creation of engineering versions: When a company creates a new engineering product, the system

automatically creates an initial engineering version for it. Only the owning engineering company will be

able to create new versions of that product.

Creation and maintenance of engineering attr ibutes:Creation and maintenance of engineering attr ibutes: When a company creates a new engineering

product, the system automatically adds engineering attributes to it. Only the owning engineering

company will be able to create and maintain the values for those attributes. For more information about

engineering attributes, see Engineering attributes and engineering attribute search.

Creation and maintenance of bills of mater ials (BOMs) that are connected to the engineeringCreation and maintenance of bills of mater ials (BOMs) that are connected to the engineering

versions:versions: The owning engineering company can directly connect a BOM to an engineering product

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/engineering-change-management/engineering-org-data-ownership-rules.md


NOTENOTE

version. When these BOMs are released to other legal entities, changes to the engineering data on the

BOMs are limited in the following ways:

The operational company can't remove released BOM lines.

The engineering fields on the BOM lines are read-only for the operational company. All other fields are

logistical implementation fields and can be edited by the operational company.

The operational company can add BOM lines to the same BOM. In this way, it can add local additions,

such as packaging materials or lubrication fluids.

The operational company can add a completely new, local BOM. This change might be required in

cases where, for example, no BOM is provided during the release. The operational company owns and

maintains these local BOMs. For more information about release management, see Release product

structures.

All local BOMs and BOM lines are preserved when the engineering company updates its BOM.

Creation and maintenance of routes that are connected to the engineering versions:Creation and maintenance of routes that are connected to the engineering versions: The

engineering company can directly connect a route to each engineering version. When these routes are

released to other legal entities, changes to the data on the routes are limited in the following ways:

The other legal entities can't remove the engineering data on the routes.

The other legal entities can add operations to the route. In this way, they can add local route steps.

Operational companies can add completely new, local routes. This change might be required if, for

example, you haven't included routes during the release. The operational companies own and

maintain these local routes. For more information about release management, see Release product

structures.

All changes that are made locally are preserved when updates from the engineering company are

released again to the routes.

Creation and maintenance of engineering documents:Creation and maintenance of engineering documents: The engineering company can attach

engineering documents to each engineering version.

When these documents are released to other legal entities, the documents are protected from being

removed by the operational company.

Other legal entities can add completely new, local documents. The operational company owns and

maintains these local documents.

Can you tell us about your documentation language preferences? Take a short survey.
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Create a product owner group

Assign a product owner to a product

Product owners and product releases

Product owners and approvals

The product owner is a group of users who are responsible for specific products. When a product owner group

is assigned to a product, only the members of that group can release the product. The product owner can also

be used in the approval workflow in engineering change management.

Product owners are global settings. Therefore, they are available to all legal entities.

To create a product owner group and add members to it, follow these steps.

1. Go to Engineering change management > Setup > Product ownersEngineering change management > Setup > Product owners .

2. On the Action Pane, select NewNew .

3. In the Product ownerProduct owner  field, enter a name for the group.

4. In the NameName field, enter a description of the group.

5. On the MembersMembers  FastTab, add the workers who should be members of the group.

To assign a product owner to a product, follow these steps.

1. Open the Product detailsProduct details  page for the relevant product or product master.

2. On the GeneralGeneral  FastTab, set the Product ownerProduct owner  field to the name of the relevant product owner group.

While a product owner is assigned to a product, only the members of the product owner group can edit the

Product ownerProduct owner  setting.

The product owner is also visible on the Released productsReleased products  page.

Only users from a product's product owner group can release that product. However, there is an exception when

the product is a child item, and its parent is released by the parent's owner. In other words, if the product is part

of the BOM of another product, the system doesn't check the product owner of each item in the BOM. It checks

only the product owner of the parent item.

For example, product X is assigned to the Design cabinets product owner group. Product X is also part of the

BOM of product Y, which is assigned to the Design Speakers product owner group. If a user from the Design

Speakers product owner group releases product Y and its BOM, product X will be released together with product

Y.

Because product owners know whether specific engineering changes will benefit their products, it often makes

sense to include them as part of the approval process in engineering change management. You can implement

this approach by setting up the product owners as participant providers in the workflows that are used for

engineering change management. The system will then assign approval tasks in the workflows, based on the

products that are in engineering change requests and engineering change orders. For more information, see

Manage changes to engineering products.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/engineering-change-management/product-owner.md
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Engineering attributes

Create engineering attributes and attribute typesCreate engineering attributes and attribute types

Set up engineering attribute typesSet up engineering attribute types

Set up engineering attributesSet up engineering attributes

To ensure that all product master data can be registered in the system, you should use engineering attributes to

specify all non-standard characteristics. You can then use engineering attribute search to easily find products,

based on those registered characteristics.

Typically, engineering products have many characteristics and properties that you must capture. Although you

can register some of the properties by using the standard product fields, you can also create new engineering

properties as required. You can define your own engineering attributes and make them part of the product

definition.

Each engineering attribute must belong to an attribute type. This requirement exists because each engineering

attribute must have a data type that defines the types of values that it can hold. An engineering attribute type

can be a standard type (such as free text, integer, or decimal) or a custom type (such as text that has a specific set

of values to select from). You can reuse each attribute type with any number of engineering attributes.

To view, create, or edit an engineering attribute type, follow these steps.

1. Go to Engineering change management > Setup > Attr ibutes > Attr ibute typesEngineering change management > Setup > Attr ibutes > Attr ibute types .

2. Select an existing attribute type in the list pane, or select NewNew  on the Action Pane to create a new

attribute type.

3. Set the following fields:

Attr ibute type nameAttr ibute type name – Enter a name for the attribute type.

TypeType – Select a standard data type (Currency, DateTime, Decimal, Integer, Text, Boolean, or Reference).

Fixed listFixed list – This option is available only if you set the TypeType field to Text. Set it to Yes to define specific

values for attributes of this type. In this case, a drop-down list will be created. You use the ValueValue

FastTab to establish the values that are available for this attribute type. Set this option to No to allow

users to enter any value. In this case, an input field will be created.

Value rangeValue range – This option is available only if you set the TypeType field to Integer, Decimal, or Currency.

Set it to Yes to establish minimum and maximum values that will be accepted for attributes of this

type. You use the RangeRange FastTab to establish the minimum and maximum values, and (for currency)

the currency that applies for the limits that you entered. Set this option to No to accept any value.

Unit of measureUnit of measure – This field is available only if you set the TypeType field to Integer or Decimal. Select

the unit of measure that applies for this attribute type. If no unit is required, leave this field blank.

To view, create, or edit an engineering attribute, follow these steps.

1. Go to Engineering change management > Setup > Attr ibutes > Engineering attr ibutesEngineering change management > Setup > Attr ibutes > Engineering attr ibutes .

2. Select an existing attribute in the list pane, or select NewNew  on the Action Pane to create a new attribute.

3. Set the following fields:

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/engineering-change-management/engineering-attributes-and-search.md
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Search for products by using engineering attribute values

NameName – Enter a name for the attribute. This name appears only on the Engineering attr ibutesEngineering attr ibutes  page.

Everywhere else in the system, the value of the Fr iendly nameFriendly name field is usually shown to identify the

attribute.

Attr ibute typeAttr ibute type – Select an attribute type that you defined in the previous section.

Fr iendly nameFriendly name – Enter a name that will identify the attribute in the system (except on the

Engineering attr ibutesEngineering attr ibutes  page).

Descr iptionDescr iption – Enter a description of the attribute.

Help textHelp text – Enter Help text that tells other users what the attribute is for.

Default valueDefault value – Enter a default value for the attribute. The options that are presented depend on the

attribute type that you selected.

CurrencyCurrency  – If the attribute type that you selected is a currency, select the currency that the attribute

will accept and show values in.

4. If the attribute type that you selected is an integer or a decimal, the RangeRange FastTab is shown. On this

FastTab, set the following fields as required:

Tolerance actionTolerance action – Select how the system should respond if a user enters a value outside the

specified range. If you select Warning, a warning is shown, but the user can save the value. If you

select Not allowed, a warning is shown, and the value can't be saved until the user corrects it.

MinimumMinimum – Enter the minimum recommended or accepted value.

MaximumMaximum – Enter the maximum recommended or accepted value.

Some engineering attributes apply to all products, whereas others are specific to individual products or product

categories. For example, electrical attributes aren't required for mechanical products. Therefore, you can set up

engineering product categories. An engineering product category establishes the collection of engineering

attributes that must be part of the definition for products that belong to that category. You can also specify

which engineering attributes are mandatory and whether there is a default value.

For more information about how to work with engineering product categories, including information about how

to connect attributes to categories, see Engineering versions and engineering product categories.

The engineering attributes that are connected to an engineering product category are presented when you

create a new engineering product that is based on that category. At that time, you can set values for the

attributes. Later, those values can be changed on the Engineering versionEngineering version page or as part of engineering

change management in an engineering change order. For more information, see Manage changes to

engineering products.

To create an engineering product, open the Released productsReleased products  page. Then, on the Action Pane, on ProductProduct

tab, in the NewNew  group, select Engineering productEngineering product.

You must specify the engineering category that the product belongs to. The category will set all the default

values and characteristics for the product. It will also set the attributes that are applicable to the product. After

the category is selected, values will be set for the attributes. You can then modify those values.

You can use engineering attribute search to find products by searching for their engineering attributes values.

Therefore, you can easily find engineering products, based on their characteristics. You can search in the

products that belong to an engineering product category, or you can search across all engineering products.

The search is available on product master data pages and from transactional items in the system, such as sales
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orders. For a transactional item, you can use the Engineering attr ibute searchEngineering attr ibute search page to search for a product.

You can then use the Add as new lineAdd as new line button to add the product to the sales order lines. Products in the search

results can also be added directly to the order.
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Engineering versions

Engineering products evolve during their product lifecycle, for many reasons. For example, changes might be

introduced to improve product serviceability, change a component because the supplier no longer offers it,

respond to new insights, or fix mistakes in the initial design. There are also many reasons why these changes

should be stored as part of an ongoing product, in such a way that previous data isn't overwritten. Here are

some of these reasons:

You want to keep track of the product as it was manufactured and delivered to your customers in previous

lifecycle states.

You need a lead time before you approve and apply the changes.

You want to have a timestamp on each change, and you want to be able to deliver previously manufactured

products separately from each other.

Engineering versions ensure that the various states of a product and its data are kept current and clear, and that

they can be visualized in the system. This concept helps you maintain consistency, lock down the bill of materials

(BOM) for production, eliminate variability, and easily identify changes.

Generally, the form-fit-function rule is applied to determine whether a change requires a new product, a new

version, or an update to an existing version. Each of the three terms in the name of this rule refers to a specific

aspect of a part, which helps engineers match parts to needs. The form-fit-function rule increases the flexibility

of design changes, because minimal documentation and design cost are required to change a part, provided

that the fit, form, and function of the product are maintained.

FitFit refers to the ability of the part or feature to connect to, mate with, or join to another feature or part in an

assembly. The fit enables the part to meet the required assembly tolerances so that it can be useful.

FormForm refers to characteristics of a part or assembly, such as the external dimensions, weight, size, and visual

appearance. The form is the aspect that is most affected by an engineer's aesthetic choices. It includes the

enclosure, chassis, and control panel, which become the outward "face" of the product.

FunctionFunction is a criterion that is met when the part effectively and reliably performs its stated purpose. For

example, in an electronics product, function can depend on the solid-state components that are used, and the

software or firmware. Often, it can also depend on the features of the selected enclosure. Two of the most

common reasons that an enclosure can fail the function criterion are poorly placed or poorly sized ports, and

misleading or missing labeling.

When you use engineering products, each product has at least one engineering version. The initial engineering

version is automatically created when you create an engineering product. Each engineering version stores the

engineering-relevant data that is specific to that version. Here are some examples of this data:

The version number and previous version number (if applicable)

The effective-from and effective-to dates

The product version active status, which indicates whether the version can be released and used in

transactions (For more information, see Product readiness.)

The engineering company that created and owns the product (For more information, see Engineering

companies and data ownership rules.)

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/engineering-change-management/engineering-versions-product-category.md
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Related engineering documents, such as an assembly manual, user instructions, pictures, and links

The engineering attributes (For more information, see Engineering attributes and engineering attribute

search.)

The engineering BOMs

The engineering routes

You can update this data on an existing version, or create a new version, by using an engineering change order.

(For more information, see Manage changes to engineering products.) If you create a new version of a product,

the system copies all engineering-relevant data to that new version. You can then modify the data for that new

version. In this way, you can track specific data for each consecutive version. To compare the differences between

consecutive engineering versions, inspect the engineering change order, which includes change types that

indicate all changes.

As has been stated, the initial engineering version is automatically created when you create an engineering

product. The version number for this version follows the version number rule that is defined in the engineering

category for the product. To transition to a subsequent version, you must add the product to an engineering

change order as a line, and you must set the ImpactImpact field to New version. The engineering change order will

include the details of the change from the current version to the next version.

Note that an engineering product can be in only one engineering change order at a time. This restriction ensures

data accuracy, and helps avoid overlapping or contradictory changes in the product. Also note that the

EngineerEngineer  field in the HeaderHeader  view of the engineering change order shows the engineer who is responsible for

the change order. If the engineer belongs to a team that is defined in the system, the ResponsibleResponsible field shows

the leader of that team.

When you use engineering change management, your product master data always includes one or more

engineering versions. In your setup of engineering products, you can choose whether the engineering version is

also part of logistical transactions. (For more information, see the Set up engineering product categories section

later in this topic.) If the logistical impact is relevant, it differs per product and per company. Sometimes, only the

latest version of a product is used. Therefore, when you introduce a new version, the previous version can no

longer be used. In other cases, the previous version is required in logistical transactions to overcome the

following challenges:

The Logistics department must ship two pieces of a product to a customer. In this case, you must decide

whether you want or will allow two different versions to be shipped.

It's later discovered that a problem occurs, and that it's related to a specific change. In this case, it might be

beneficial to determine exactly which version was shipped in each order.

Companies typically want to ship old versions first, to phase them out of inventory. Especially for low-volume

products, this approach can often be managed by determining the effectivity dates of the new version in

relation to predictions about when stock of the old version will be depleted. However, sometimes you might

not be able to make this comparison, or you may consider the uncertainty of stock level predictions to be too

high.

The decision about whether to make versions visible in inventory depends on factors such as those that were

previously mentioned, plus company practice and other considerations that are specific to each company. You

can specify the behavior for the engineering product category. It will then apply to all products that are created

from that category, for all companies that the product is released to.

For products that are set up so that they have logistical impact, the engineering version must be specified on

each transaction. Although the system will propose the latest active version, you can select among all the active

versions that are available for the company. For products that are set up so that they don't have logistical impact,

the engineering version isn't specified on transactions. However, the system uses the latest active version. For



 Set up engineering product categories
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Name Enter a name for the engineering product category.

Engineering company Select the engineering company where products in this
engineering product category can be created and where
they will be maintained.

Details FastTabDetails FastTab
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Product type Select whether the category applies to products or services.

example, when you add a product to a production BOM, the latest version will be used, and when you run

master planning, the latest version will be assumed.

An engineering product category provides a basis for creating a specific engineering product. Each category

establishes a set of default values and policies. Therefore, when you create an engineering product, you first

select the category to create it from.

Note that a new category hierarchy type (engineering product hierarchy) is automatically set up for you. You can

manually create the categories by going to Engineering change management > Setup > EngineeringEngineering change management > Setup > Engineering

product categor y detailsproduct categor y details .

Each engineering product category establishes the default behavior of the engineering products that are created

based on that category. After you've created an engineering product, you can't change its engineering product

category. However, if you select the incorrect category, you can delete the product and then re-create it.

When an engineering product category is created, you're prevented from changing the following settings:

Engineering company

Product type

Product subtype

Product dimension group

Configuration technology

Version number rule

Other settings might inherit default values that are set up for the engineering product category. However,

according to the system rules, those values can be changed.

To work with engineering product categories, go to Engineering change management > Setup >Engineering change management > Setup >

Engineering product categor y detailsEngineering product categor y details . Then follow one of these steps.

To create a new category, select NewNew  on the Action Pane, and then set the fields as described in the following

subsections.

To edit an existing category, select it in the list pane, select EditEdit on the Action Pane, and then set the fields as

described in the following subsections.

To delete an existing category, select it in the list pane, and then select DeleteDelete on the Action Pane.

Set the following fields on the header of an engineering product category.

Set the following fields on the DetailsDetails  FastTab of an engineering product category.



Track versions in transactions Select whether the version of the product should be
stamped on all transactions (logistical impact). For example, if
you track the version in transactions, each sales order will
show which specific version of the product was sold in that
sales order. If you don't track the version in transactions,
sales orders won't show which specific version was sold.
Instead, they always show the latest version.

Product subtype Select whether the category will hold products or product
masters. For product masters, product dimensions will be
used.

Product dimension group The Track versions in transactionsTrack versions in transactions setting helps you
select the product subtype. If you specifed that you want to
track the version in transactions, the product dimension
groups where the version dimension is used will be shown.
Otherwise, only product dimension groups where the
version dimension isn't used will be shown.

Product lifecycle state at creation Set up the default product lifecycle state that an engineering
product should have when it's first created. For more
information, see Product lifecycle states and transactions.

Version number rule Select the version number rule that applies to the category:

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

If this option is set to Yes, a product master is created
for the product, and each version of the product will
be a variant that uses the version product dimension.
The Product subtypeProduct subtype field is automatically set to
Product master, and you must select a product
dimension group where the version dimension is
active. Only product dimension groups where version
is an active dimension will be shown. You can create
new product dimension groups by selecting the EditEdit
button (pencil symbol).

If this option is set to No, the version product
dimension won't be used. You can then select
whether to create a product or a product master that
uses the other dimensions.

This option is often used for products that have a cost
difference between versions, or products where different
conditions apply in relation to the customer. Therefore,
it's important to indicate which version was used in each
transaction.

ManualManual – You choose the version number for each
new version.

AutomaticAutomatic – The system sets the version number,
based on a format that you define. When you set up
the format, use a number sign (#) to represent a digit
and any other character to represent a constant
value. For example, if you define the format as V-##,
the first version will be "V-01," the second version will
be "V-02," and so on.

ListList  – The system takes the next number from a
predefined list of custom values that you define.



Enforce effectivity Select whether the effectivity dates of engineering versions
must be contiguous, or whether there can be gaps and
overlaps. This setting affects the way that you can use the
Effective fromEffective from and Effective toEffective to fields for each engineering
version where the category applies.

Use number rule nomenclature Set this option to Yes to enable rules for defining a product
number by using number sequences, engineering attribute
names and values, and text constants as segments. To create
or modify rules, select the EditEdit  button.

Use name rule nomenclature Set this option to Yes to enable rules for defining a name by
using the engineering attribute names, engineering attribute
values, and text constants as segments. To create or modify
rules, select the EditEdit  button.

Use description rule nomenclature Set this option to Yes to enable rules for defining the
description by using the engineering attribute names,
engineering attribute values, and text constants as
segments. To create or modify rules, select the EditEdit  button.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Attributes FastTabAttributes FastTab

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Name Select the attribute to add.

If this option is set to Yes, an Effective fromEffective from value
must be specified for each version, and neither
overlaps nor gaps are allowed between versions. The
date range for each engineering version is connected
directly to the previous and next engineering
versions, if they exist. In this scenario, the newest
version is always used, and older versions are no
longer used.

If this option is set to NoNo, there are no restrictions on
the effectivity date fields for engineering versions,
and both overlaps and gaps are allowed. In this
scenario, multiple versions can be active at the same
time, and you can work with any active version.

This option also affects BOMs and routes that are
connected to a product version. For more information,
see the Connect BOMs and routes to engineering
versions section later in this topic.

Use the grid on the Attr ibutesAttr ibutes  FastTab to set up the engineering attributes that apply to products that belong to

this category. For information about how to create engineering attributes, see Engineering attributes and

engineering attribute search.

Use the buttons on the Attr ibutesAttr ibutes  FastTab to add, remove, and arrange attributes in the grid.

If you change the selection of attributes for an engineering category, and products already exist that are based

on that category, you must decide whether to apply your changes to those products. If you want existing

products to reflect the changes, select Update existing productsUpdate existing products  on the Attr ibutesAttr ibutes  FastTab.

For each row that you add to the grid, set the following fields.



 

Value Select the default value for the attribute.

Mandatory For attributes of the Boolean type, if this option is set to Yes,
users must set the attribute to Yes. If this option is set to No,
users can set the attribute to either Yes or No. For other
data types, the setting of this option is just informational.

Batch attribute Select whether the attribute should be propagated through
the batch functionality.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Readiness policy FastTabReadiness policy FastTab

Release policy FastTabRelease policy FastTab

Connect BOMs and routes to engineering versions

Use the Product readiness policyProduct readiness policy  field to select the readiness policy that applies to products that belong to

this category. For more information, see Product readiness.

Use the Product release policyProduct release policy  field to select the release policy that applies to products that belong to this

category. For more information, see Release product structures.

The setting of the Enforce effectivityEnforce effectivity  option is important for the connection of BOMs and routes to each

engineering version. You can activate multiple BOMs or routes per product only if there is a difference in any of

the following settings:

Product dimension

Quantity

Site

Effectivity dates

Engineering BOMs and routes are created from the engineering version where they apply. They can be

recognized by the check mark in the Engineering controlledEngineering controlled check box. When you work with engineering

BOMs and routes, you won't typically design them by using different quantities. You also won't typically design

different BOMs per site. Additionally, for engineering BOMs and routes, the effectivity dates are always taken

from the engineering version. Therefore, an engineering version, its BOM, and its route will all have the same

effectivity dates.

For products where you're using the version product dimension (together with logistical impact on the

transactions), the version is also added to the BOMs and routes. This behavior helps differentiate the BOMs and

routes of consecutive versions, regardless of the Enforce effectivityEnforce effectivity  setting.

For products where you aren't using the version product dimension (without logistical impact on the

transactions), the version isn't added to the BOMs or routes. Therefore, there will be no difference between the

BOMs and routes of consecutive versions. In this case, we highly recommend that you set the EnforceEnforce

effectivityeffectivity  option to Yes. In this way, you help prevent engineering versions from overlapping, and you can also

activate the BOM and route of a newer version without first having to inactivate the BOM and route of the

previous version. If you do set the Enforce effectivityEnforce effectivity  option to Yes in this case, you must manually inactivate

the BOMs and routes of older versions before you can activate the latest version.
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Turn on the feature in your system

Restrictions and limitations

Prepare for conversion by creating all required engineering product
categories

This topic explains how you can enable change management for existing products. It also describes cases where

your ability to enable change management is limited.

When you enable change management for an existing product, you can create versions of that product and trace

changes that are made to it throughout its life. Therefore, you can track those changes by using change orders.

To enable change management, you must convert the relevant products to engineering items (also referred to

as engineering products). Engineering products are products that are versioned and managed through change

management. A wizard is provided to guide you through the conversion process.

To use this capability, you must complete the following tasks:

1. Enable the Engineering change management feature and its configuration key as described in Engineering

change management overview.

2. Turn on the Enable change management on existing products feature in feature management. For more

information, see Feature management overview.

Not all product types can be converted to all other types. The following restrictions and limitations apply:

When you convert a product to an engineering product, it remains a product. It doesn't become a product

master.

When you convert a product master that has a specific set of dimensions, those dimensions are maintained

after the change. For example, if you convert a product master that has the size dimension, it will keep the

size dimension.

Therefore, if you have a distinct product, you can change it only to an engineering product that doesn't track the

product dimension in transactions (that is, the version dimension isn't used). See the remaining sections of this

topic for more information about these issues.

An engineering product category must be assigned to every engineering product. You will do this assignment

when you run the Conver t to engineering productConver t to engineering product wizard. Engineering product categories must exist for all

relevant standard products before you can convert those products.

The engineering product category provides a basis for creating an engineering product, and it establishes a set

of default values and policies. The engineering product category must match the product that you assign it to.

For example, the product type and dimension group must match both the product and its engineering product

category. For more information, see Engineering versions and engineering product categories.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/engineering-change-management/change-management-existing-products.md
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Run the Convert to engineering product wizard

The Conver t to engineering productConver t to engineering product  wizard can convert product only to engineering products where the version isn't

tracked in transactions. Therefore, the Track version in transactionsTrack version in transactions option must be set to No for engineering product

categories that you create to convert existing products.

For information about how to create engineering product categories, see Engineering versions and engineering

product categories.

The Conver t to engineering productConver t to engineering product wizard helps you convert one or more existing products to engineering

products. It converts the products into engineering products (versioned products) where the version isn't

tracked in transactions (that is, the version dimension isn't used). After the conversion is completed, you can

manage the products by using Engineering change management.

The conversion is permanent. Therefore, you won't be able to reverse it later.

Each converted engineering product will continue to be released in the same companies that the original

product was released in. However, the engineering bill of materials (BOM) and routes won't automatically be

released to those companies.

Follow these steps to run the Conver t to engineering productConver t to engineering product wizard and convert a product to an

engineering product.

1. Go to Product information management > Products > Released productsProduct information management > Products > Released products .

2. In the grid, select the check box for each product that you want to convert.

3. On the Action Pane, on the EngineerEngineer  tab, in the Engineering change managementEngineering change management group, select

Conver t to engineering productConver t to engineering product to open the wizard.

4. The first page of the wizard is the WelcomeWelcome page. If you aren't already familiar with the conversion

process, carefully read the information on this page. When you're ready to continue, select NextNext.

5. The Select details for the products to be conver tedSelect details for the products to be conver ted page shows each product that you selected

before you opened the wizard. Inspect the list. Use the NewNew  and DeleteDelete buttons on the toolbar to add or

remove products as you require.

6. Use the following fields at the top of the grid to assign default values to every product that is listed. (You

will be able to change these values for individual products after the conversion is completed.) Default

values won't be assigned to products where a relevant value has already been assigned.

Default engineering categor yDefault engineering categor y  – Select an initial engineering product category to assign to every

listed product. The category that you select will be applied only to products that are compatible with it.

Default versionDefault version – Enter the initial product version to assign to every listed product. Every

engineering product has at least one engineering version.

Default lifecycle stateDefault lifecycle state – Select the initial product lifecycle state to assign to every listed product.

Current BOM will be par t of the engineering productCurrent BOM will be par t of the engineering product – Select this check box if the current BOM

for each listed product should be used as a BOM for the engineering product.

For more information about product settings, see the next step.

7. Review each product that is listed in the grid, and evaluate how well the default values that you assigned

apply to it. For each row, review the following information and set any relevant fields:

Product numberProduct number  – The product number.
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Product nameProduct name – The name of the product.

Engineering categor yEngineering categor y  – Select the engineering product category that the product should belong to

after it's converted. An appropriate category must already exist for each product, as was explained in

the previous section of this topic. You must assign a category to every product.

VersionVersion – Enter the product version to assign to the product after it's converted. For example, you

might select a number that fits in the number sequence that your category already uses. Each

engineering version stores the engineering-relevant data that is specific to that version. For more

information, see Engineering versions and engineering product categories.

Product lifecycle stateProduct lifecycle state – Select the product lifecycle state that the product should be in after it's

converted. The product lifecycle state lets you to control which transactions are allowed for a given

engineering version. For more information, see Product lifecycle states and transactions.

Has BOMHas BOM – A selected check box indicates that the product has a BOM. The setting of this check box

can help you decide how to set the Current BOM will be par t of the engineering productCurrent BOM will be par t of the engineering product check

box.

Current BOM will be par t of the engineering productCurrent BOM will be par t of the engineering product – Select this check box if the current BOM

of the product should be used as a BOM for the engineering product. That BOM will then be managed

by Engineering change management. If the product doesn't have a BOM, or if you prefer to manually

create a BOM for the converted product later, clear this check box.

Has errorsHas errors  – A selected check box indicates that the product setup has one or more errors. For

example, the product type or the dimension group might not match in the category. Products that

have errors will be skipped and won't be converted.

8. When you've finished, select ValidateValidate on the toolbar to validate the product setup. For each row, the HasHas

errorserrors  check box will be updated to indicate the product's status. Adjust the values until the setup of

every product is free of errors.

9. When all the products are set up correctly, select NextNext to continue.

10. The Confirm selectionConfirm selection page shows the number of products that have no errors in their setup and are

therefore ready for conversion. It also shows the number of products that will be skipped because of

errors. To run the conversion as a batch job, set the Run in batchRun in batch option to Yes.

11. Select FinishFinish to apply your settings and start to convert the products to engineering products.

If your system is set up to manually accept products before they are released, you must accept each converted product

by using the Open product releasesOpen product releases page in the appropriate companies. For more information, see Review and accept

the product before you release it in the local company.
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Create and manage product lifecycle states

NOTENOTE
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State Enter a name for the product lifecycle state.

Description Enter a description of the product lifecycle state.

General FastTabGeneral FastTab
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As an engineering product goes through its lifecycle, it's important that you be able to control which

transactions are allowed for each lifecycle state. For example, products that aren't yet in a mature state should

not be put on a sales order. Alternatively, if a product is reaching its end-of-life state, you might want to control

the inflow of that product.

For an engineering product, changes to the lifecycle state are connected to the product's engineering versions.

Therefore, the product's lifecycle state can also be connected to its engineering versions. When the product

lifecycle state is connected to an engineering version, you can use the lifecycle state to control which

transactions are allowed for the engineering version.

To work with product lifecycle states, go to Engineering change management > Setup > ProductEngineering change management > Setup > Product

lifecycle statelifecycle state. Then follow one of these steps.

To create a new lifecycle state, select NewNew  on the Action Pane, and then set the fields as described in the

following subsections.

To edit an existing lifecycle state, select it in the list pane, select EditEdit on the Action Pane, and then set the

fields as described in the following subsections.

To delete an existing lifecycle state, select it in the list pane, and then select DeleteDelete on the Action Pane.

Engineering products use the same product lifecycle states as standard (non-engineering) products. You can also open the

Product lifecycle stateProduct lifecycle state page that is described in this topic by going to Product information management >Product information management >

Setup > Product lifecycle stateSetup > Product lifecycle state. For more information about product lifecycle states, for both engineering products

and standard products, see Product lifecycle state overview.

Set the following fields on the header of a product lifecycle state.

Set the following fields on the GeneralGeneral  FastTab.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/engineering-change-management/product-lifecycle-state-transactions.md


Default when released to a legal entity For standard products, set this option to Yes if this lifecycle
state should be applied to all products by default when they
are first released. Set it to No if this lifecycle state will be
manually applied later.

Is active for planning Set this option to Yes to include products that are in this
lifecycle state in calculations at the master planning and bill
of materials (BOM) levels. Set it to No to exclude products
that are in this lifecycle state from the calculations.
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Enabled business processes FastTabEnabled business processes FastTab
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Process This read-only field shows the name of an existing business
process.

Process area This read-only field shows the name of an existing process
area.

This setting isn't applicable to engineering products. The
lifecycle state of an engineering product version after it's
created in the engineering company is specified in its
engineering change category. When the product is
released to an operational company, the lifecycle state of
the product is copied. In other words, when an
engineering product is released to an operational
company, it has the same lifecycle state that it had in the
engineering company. The lifecycle state can be
overwritten in the operational company.

Use the Enabled business processesEnabled business processes  FastTab to control which of the available business processes can be used

with products in the current lifecycle state. The processes that are listed on this FastTab are automatically found

in the following way:

The first time that you save a new lifecycle state, the page loads the business processes that are currently

available.

If you add new business processes to your system, you can update the list on the Enabled businessEnabled business

processesprocesses  FastTab for an existing lifecycle state by selecting Check for updatesCheck for updates  on the Action Pane.

The following fields are available for each process that is listed on the Enabled business processesEnabled business processes  FastTab.



Policy Select one of the following values to control whether and
how the current process will be permitted for products that
are in this lifecycle state:
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EnabledEnabled – The business process is allowed.

BlockedBlocked – The process isn't allowed. If a user tries to
use the process on a product that is in this lifecycle
state, the system will block the attempt and show an
error instead. For example, you might block end-of-
life products from being purchased.

Enabled with warningEnabled with warning – The process is allowed,
but a warning will be shown. For example, you might
want a prototype product to be put on a production
order that is created by the Research and
Development department. However, other
departments should be aware that they should not
produce the product yet.

If you're adding more lifecycle state rules as a customization, you can view those rules in the user interface (UI)

by selecting Refresh processesRefresh processes  in the upper pane. The Refresh processesRefresh processes  button is available only to

administrators.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Engineering change requests

Create a new engineering change requestCreate a new engineering change request

General FastTabGeneral FastTab
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Change request Enter a name for the engineering change request.

Title Enter text that briefly describes or identifies the changes in
the request.

Engineering change management provides structured processes for managing changes to engineering

products. You can use the engineering change request process to propose and request changes, and then use

the engineering change order process to actually make those changes. Users can create engineering change

requests or engineering change orders, and there is then a process for reviewing and approving them, assessing

their impact on existing transactions, and following up on them.

The engineering change request process lets you capture requests for changes from all the relevant

departments in your company. It doesn't matter whether you work as an engineer, or in the Manufacturing,

Sourcing, Warehouse, or Sales department: anybody can use an engineering change request to request a

change. This change might be an idea for a new product, an issue that you discovered while you were working

with an existing product, a suggestion for improving an existing product, or something else.

After someone submits a request for change, the review and approval process is managed by a workflow that

identifies who must approve the change (for example, the product owner).

To set up a workflow for engineering change orders or engineering change requests, go to EngineeringEngineering

change management > Engineering workflowschange management > Engineering workflows . Select NewNew , select whether the workflow will be used to

review engineering change orders or engineering change requests, and then configure the workflow.

For more information about workflows see Workflow system overview. For more information about product

owners, see Product owners.

To create an engineering change request, follow one of these steps.

Go to Engineering change management > Common > Engineering change management >Engineering change management > Common > Engineering change management >

Engineering change requestsEngineering change requests , and then select NewNew  on the Action Pane.

Open the Product detailsProduct details  page for an existing engineering product. Then, on the Action Pane, on the

EngineerEngineer  tab, in the Engineering change managementEngineering change management group, select Engineering change request >Engineering change request >

New engineering change requestNew engineering change request.

A new change request is created. You can now set the fields on each FastTab, as described in the following

subsections.

The GeneralGeneral  FastTab lets you provide a basic description of the change request. The following table describes

the fields on this FastTab.
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Priority Select a value to indicate how high the priority of the change
is. You can customize the available values for your company,
as required. (For more information, see Establish common
values for engineering change management.)

Category Select a value to describe the type of change that you're
requesting. You can customize the available values for your
company, as required. (For more information, see Establish
common values for engineering change management.)

Severity Select a value to indicate the severity of the issue that
should be fixed by implementing the request. You can
customize the available values for your company, as
required. (For more information, see Establish common
values for engineering change management.)

Requested by The name of the user who created the request.

On The date when the request was created.

Status The status of the request. When a request is first created,
the status is Created. When the request is approved, the
status changes to Approved. If a related change order has
been created for the request, the status changes to Followed
up.

Change order The change order number, if the change request was
followed up on via a change order.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Information FastTabInformation FastTab
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Created date and time The date and time when the row was created.

Type The type of information that the row was created for (file,
image, note, or URL).

Description Enter a description for the row.

Restriction A value that indicates whether the information that has been
added came from an internal or external source.

The InformationInformation FastTab lets you add more information about the request.

To add a row to the grid, select NewNew  on the toolbar above the grid, and then select one of the following options:

FileFile – Upload a file.

ImageImage – Upload an image file.

NoteNote – Enter a note directly in the grid.

URLURL  – Enter a URL directly in the grid.

The following table describes the fields on each row.



Attached A selected check box indicates that the row includes an
attachment (file or image). To download the attachment,
select the row, and then select OpenOpen on the toolbar above
the grid.
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Products FastTabProducts FastTab

Source FastTabSource FastTab

Evaluate the business impact of a change requestEvaluate the business impact of a change request

Create a change order from a change requestCreate a change order from a change request

Engineering change orders

The ProductsProducts  FastTab lets you list each product that is affected by the change request. You can use the buttons

on the toolbar to add products to the grid, or to remove products.

This list is for informational purposes only. Therefore, you can add as many related products as you consider

relevant. If you create a change request from the Product detailsProduct details  page for an existing product, that product

should be listed on the ProductsProducts  FastTab after you save the request record.

The SourceSource FastTab lets you track the starting point of the change request. It's useful if, for example, you want to

see whether the change request was created from a sales order, who created it, and which company it was

created in.

When you review a request for change, you can search for dependencies. In this way, you can assess the impact

of the requested change on open transactions, such as sales orders, production orders, and on-hand inventory.

1. Go to Engineering change management > Common > Engineering change management >Engineering change management > Common > Engineering change management >

Engineering change requestsEngineering change requests .

2. Either open an existing change request, or select NewNew  on the Action Pane to create a new change request.

3. On the Action Pane, on the Change requestChange request tab, in the Business impactBusiness impact group, select one of the

following buttons:

SearchSearch – Scans all open transactions, and then open the Business impact to open transactionsBusiness impact to open transactions

dialog box, which lists all transactions that will be affected by the change.

View previous searchView previous search – Open the Business impact to open transactionsBusiness impact to open transactions  dialog box, which lists

the results of the previous search. (A new search isn't done.)

4. If the issue that requires a change is found to be critical, you can block the open transactions or notify the

responsible user by using the buttons on the toolbar in the Business impact to open transactionsBusiness impact to open transactions

dialog box.

An engineer who is reviewing an engineering change request can create an engineering change order directly

from the Engineering change requestsEngineering change requests  page. On the Action Pane, on the Change requestChange request tab, in the

Engineering change orderEngineering change order  group, select Copy link and productsCopy link and products .

Engineering change orders provide a structured process for making changes to engineering products. You

propose changes by using a copy of the engineering-relevant data. The real master data isn't affected. For more

information about engineering-relevant data, see Engineering versions and engineering product categories.

You can create an engineering change order that is based on an approved engineering change request.

Engineers can also create engineering change orders from scratch. You can include multiple products on a single

engineering change order by following any of these steps:

Manually select products.



Engineering change orders in engineering or operational companiesEngineering change orders in engineering or operational companies

Use the bill of materials (BOM) to include products that are lower in the product structure (that is, children).

Use a where-used search to include products that are higher in the product structure (that is, parents).

After the proposal for changes is completed, the review and approval process will be handled by a workflow. You

can set up different workflows, based on priority and severity.

To set up a workflow for engineering change orders or engineering change requests, go to EngineeringEngineering

change management > Engineering workflowschange management > Engineering workflows . Select NewNew , select whether the workflow will be used to

review engineering change orders or engineering change requests, and then configure the workflow.

For more information about workflows, see Workflow system overview.

Here are some typical stakeholders who might have to approve an engineering change order :

Product ownersProduct owners  – For more information about product owners, see Product owners.

Responsible team leadResponsible team lead – The EngineerEngineer  field in the HeaderHeader  view of the engineering change order shows

the engineer who created the engineering change order. If the engineer belongs to a team that is defined in

the system, the ResponsibleResponsible field shows the leader of that team.

Finance depar tmentFinance depar tment – The Finance department might have to review cases where the change involves

high costs.

You can choose whether the engineering change order should be processed directly after it's approved, as part

of the workflow, or whether the processing should be done later, as a manual step. During processing of an

engineering change order, engineering data on the actual product is updated.

While you're reviewing a request for change, on the Action Pane, on the Change requestChange request tab, in the BusinessBusiness

impactimpact group, select SearchSearch to assess the impact of the proposed change on open transactions, such as sales

orders, production orders, and inventory on-hand. The results are shown in the Business impact to openBusiness impact to open

transactionstransactions  dialog box, where you can select impacted transactions and then use commands in the toolbar to

view more information, notify the responsible user, or block the transaction.

As is described in Engineering companies and data ownership rules, the product data that you can edit varies,

depending on the type of legal entity that you're working in (an engineering company versus an operational

company). Data ownership rules are also applied to engineering change orders. Therefore, depending on the

legal entity where you create an engineering change order, different types of changes can be made. Here are

some examples:

For engineering change orders in an engineering companyengineering company , you can make basic changes to the

engineering data. For example, you can create new versions of a product, change a product's structure via

the BOM, and change engineering attribute values. For each affected product, select one of the following

values in the ImpactImpact field:

NoneNone – Update the existing product version (in-version update).

New versionNew version – Create a new version that is based on the selected product version.

New productNew product – Create a completely new product or product variant that is based on the selected

product version.

For engineering change orders in an operational companyoperational company , you can change the logistical data of the

product. For example, you can enrich the existing BOM with settings for sourcing, add local routes or local

BOMs, and even enrich a BOM by adding new BOM lines for local packaging materials, lubrication fluids,

or instructions in the local language. Enrichments that users make in the operational company will be

preserved when new updates are sent from the engineering company. For more information, see

Engineering companies and data ownership rules.

When engineering change orders are processed in the engineering company, the products are created

and/or updated only in the engineering company. Therefore, if the product master data should also be



Follow up on an engineering change request via an engineering
change order

Engineering change order report

Fields on an engineering change order
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Engineering change reasons Select the reason for changing the affected product.

updated, you must also release the products to operational companies.

You can release products directly from engineering change orders. Open the change order, and then, on

the Action Pane, on the Change orderChange order  tab, in the Product releasesProduct releases  group, select Release productRelease product

structurestructure. The process works just as it works when you release products from the Released productsReleased products

page. For more information, see Release product structures.

You can have products automatically released from engineering change orders, based on the following

factors:

Re-releases to companies where products were previously released. Select SearchSearch to scan all previous

releases, and then select ViewView  to view the results. The ViewView  page shows the previous product

releases, and you can select which products you want to re-release. Then close the ViewView  page, and

select ProcessProcess  to re-release the selected products.

Automatic release settings in the release control of the engineering product category. You can do this

release as part of the workflow. When the collect release proposalcollect release proposal  block is used, the release

proposal will be filled with re-releasing proposals (see the previous list item), and products will be

released to companies if the Auto releaseAuto release check box is selected in the release control of the

engineering product category. You can select ViewView  to view the results, as described in the previous list

item. The products will also be released when the process release proposalprocess release proposal  block is used. If you

choose only to collect the release proposal as part of the workflow, you can manually start the release

by selecting ProcessProcess , as described in the previous list item.

As soon as an engineering change request is approved, you can follow up on it via an engineering change order.

You can combine multiple engineering change requests into a single engineering change order. A single

engineering change order can even include multiple products. (Typically, you use this approach when the same

change must be applied to multiple products.) However, you can't create multiple engineering change orders

from a single engineering change request.

To follow up on a change request via a change order, open the change request, and then, on the Action Pane, on

the Change orderChange order  tab, in the Engineering change orderEngineering change order  group, select Copy link and productsCopy link and products . You can

then select an existing engineering change order to connect the change request to, or you can create a new

engineering change order for that specific request.

Engineering change order reports describe the changes that were made in an engineering change order. They

are useful both during and after the review and approval process.

To view an engineering change order report, open the relevant change order, and then, on the Action Pane, on

the Change orderChange order  tab, in the ViewView  group, select Engineering change order repor tEngineering change order repor t.

Most of the fields on engineering change orders are the same as the fields for released products, engineering

versions, documents, BOMs (lines) and routes (operations). However, the fields in the following table are unique

to change orders.



Change description Enter a description of the change.

Required special tooling Specify whether special tooling is required to apply the
change.

Engineering material disposition Select a material disposition code for any waste that is
produced when the change is applied.

Customer approval required Specify whether customer approval is required before the
change can be applied.

Received customer approval Specify the status of the customer approval.

Environmental health and safety Specify whether environmental health and safety rules are
applicable to the change. If they are, you can then select the
applicable rules.
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You can use the Maintain/copy change informationMaintain/copy change information button to copy change information between affected

products.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Types of readiness checks

How readiness checks are created for a new product, variant, or
version

You can use readiness checks to ensure that all the required master data has been specified for a product before

it's used in transactions. When readiness checks are used, a user or team is made responsible for validating

specific predefined product-related data. If there is an open readiness check for a product, the product can't be

released or used in transactions.

The ActiveActive check box for an engineering product, variant, or version is available only after all the required data

has been entered and verified, and after all the readiness checks have been processed. At that point, the product,

version, or variant can be released to other companies and used in transactions. You can create readiness checks

for new products, new variants, and new engineering versions.

There are three types of readiness checks:

System checkSystem check – The system verifies whether there is a valid record. For example, the record might be an

active bill of materials (BOM).

Manual checkManual check – A user verifies whether the record is valid. For example, a readiness check might require

validation of the default order settings. In some cases, such as when the product is still being designed and

therefore won't be placed in stock, no default order settings are required. However, default order settings

might be required for another product of the same type, because the product can be held in stock. The user is

responsible for knowing how to correctly decision whether a readiness check is required.

ChecklistChecklist – The user answers a series of questions from a checklist, and the system determines whether the

answers meet expectations. The checklist can have any subject. For example, it can be used to determine

whether marketing materials or product documentation is completed.

When you create a new engineering productproduct, the system determines whether a readiness check policy has been

set up for the engineering product category. (Readiness check policies can be applied on the released product

level, the released variant level, and the engineering version level.) If a policy has been set up, the following

events occur :

Readiness checks are created for the product, according to the applicable policy.

The engineering version is set to inactive to block the product from being used. All the versions for the

specific product that is involved are set to inactive.

If a new var iantvar iant is created for a product, the system checks whether readiness checks have been set up on the

engineering product category. (Readiness checks can be applied on released variant level and the engineering

version level.) If a readiness check has been set up, the following events occur :

Readiness checks are created for the product.

The engineering version is set to inactive to block the product from being used.

If a new engineering versionversion is created for a product, the system checks whether readiness checks have been

set up on the engineering product category. (Readiness checks can be applied on the engineering version level.)

If a readiness check has been set up, the following events occur :
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View readiness checks
View open readiness checks for a product or product versionView open readiness checks for a product or product version

View open readiness checks that are assigned to youView open readiness checks that are assigned to you

Process open readiness checks
Process system and manual readiness checksProcess system and manual readiness checks

Process checklist readiness checksProcess checklist readiness checks

Readiness checks are created for the product.

The engineering version is set to inactive to block the product from being used.

To find the open readiness checks for a product, open the Released products detailsReleased products details  page. Then, on the Action

Pane, on the ProductProduct tab, in the Readiness checksReadiness checks  group, select Readiness checksReadiness checks .

To find the open readiness checks for a product version, open the Engineering versionsEngineering versions  page for a released

product and choose a version. Then, on the Action Pane, on the ProductProduct tab, in the ChecklistChecklist group, select

Readiness checksReadiness checks .

To view the open readiness checks that are assigned to you, follow one of these steps.

Go to Engineering change management > Common > Product readiness > My open readinessEngineering change management > Common > Product readiness > My open readiness

checkschecks .

Go to Product information management > Workspaces > Product readiness for discreteProduct information management > Workspaces > Product readiness for discrete

manufactur ingmanufactur ing.

The setup that specifies who a readiness check is assigned to is done for the engineering product category.

Readiness checks can be assigned to a person or a team. If a readiness check is assigned to a team, there is one

person on the team who must process the readiness check. For more information, see Engineering versions and

engineering product categories.

After you open the Readiness checksReadiness checks  page, you can view the subject of system and manual readiness checks

by selecting View related informationView related information on the Action Pane. You can then complete and/or validate the data for

the readiness check. Open readiness checks have a StatusStatus  value of Pending. This status indicates that the

readiness check must still be processed. To process a readiness check, follow one of these steps.

On the Action Pane, select Check/completeCheck/complete to review and complete the readiness check. When you've

finished, the StatusStatus  field is updated to Passed.

On the Action Pane, select SkipSkip if you want to skip a readiness check that isn't mandatory. For example, you

set up a readiness check for price calculations. However, you decide to skip this check while the product is still

in the design phase. In this case, the StatusStatus  field is updated to Skipped.

Depending on the configuration of the readiness policy, when the StatusStatus  field for a readiness check is updated

to Passed, an extra step might be required to approve the readiness check. In this case, select ApprovalApproval  to

complete the readiness check. This approval step is always mandatory when the readiness check is skipped.

When all the open readiness checks for a new product, variant, or version have been processed and approved as

required, the item automatically becomes active and therefore ready to use.

To open a checklist, open the Readiness checksReadiness checks  page, and then, on the Action Pane, select Star t checklistStar t checklist.

When you've completed the checklist, the system validates whether the readiness check is passed, based on the

settings in the questionnaire. If the check is passed, the StatusStatus  field is updated to Passed. If the readiness check

isn't mandatory, you can skip it. In this case, the StatusStatus  field is updated to Skipped.

Depending on the configuration of the readiness policy, when the StatusStatus  field for a readiness check is updated

to Passed, an extra step might be required to approve the readiness check. In this case, select ApprovalApproval  to



Create and manage product readiness policies
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Name Enter a name for the policy.

Description Enter a description of the policy.

General FastTabGeneral FastTab
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Product type Select whether the policy applies to products of the Item or
Service type. You can't change this setting after you save the
record.

Active Use this option to help maintain your readiness policies. Set
it to Yes for all readiness policies that you use. Set it to No to
mark a readiness policy as inactive when it isn't used. Note
that you can't inactivate a readiness policy that is assigned
to an engineering product category, and you can delete only
inactive release policies.

Readiness control FastTabReadiness control FastTab

complete the readiness check. This approval step is always mandatory when the readiness check is skipped.

When all the open readiness checks for a new product, variant, or version have been processed and approved as

needed, the item automatically becomes active and therefore ready to use.

Use product readiness policies to manage the readiness checks that apply to a product. Because a readiness

policy is assigned to the engineering category, all the checks in the readiness policy apply to all the engineering

products that are based on the engineering category. For more information, see Engineering versions and

engineering product categories.

Each readiness policy contains a set of readiness checks. When a readiness policy is assigned to an engineering

product category, all the products that are created from that engineering product category will have the

readiness checks that are indicated in the readiness policy.

To work with product readiness policies, go to Engineering change management > Setup > ProductEngineering change management > Setup > Product

readiness policiesreadiness policies . Then follow one of these steps.

To create a new policy, select NewNew  on the Action Pane, and then set the fields as described in the following

subsections.

To edit an existing policy, select it in the list pane, select EditEdit on the Action Pane, and then set the fields as

described in the following subsections.

To delete an existing policy, select it in the list pane, select EditEdit on the Action Pane, and then, on the GeneralGeneral

FastTab, make sure that the ActiveActive option is set to No. Then select DeleteDelete on the Action Pane.

Set the following fields on the header of a product readiness policy.

Set the following fields on the GeneralGeneral  FastTab of a product readiness policy.

For each type of readiness check that you want to include in the policy, add a row on the Readiness controlReadiness control

FastTab. Use the following buttons on the FastTab toolbar to add and remove rows as you require:

Add checkAdd check – Add a standard readiness check to the policy. When you select this button, the Add checkAdd check

dialog box appears. There, you can select from a list of available checks.
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Process area Select the area that the check is related to.

Type Select whether the check is a system check, a manual check,
or a checklist (questionnaire).

Name If the check is a checklist, enter a name. For system and
manual checks, this field is automatically set.

Description If the check is a checklist, enter a description. For system and
manual checks, this field is automatically set, and the
description explains the focus of the check.

Apply checks on Select whether the row should generate readiness checks in
response to a new released product, released variant, or
released version.

Execute in Select whether readiness checks that the row generates
apply to all companies or a single company.

Company If you set the Execute inExecute in field to Single company, select the
company.

Owner type Select whether readiness checks that the row generates
should be assigned to a person or a team.

Owner Select the person or team that readiness checks that the row
generates should be assigned to.

Questionnaire Select the questionnaire that should be used for the
checklist. The checklist is a local checklist in the company
where the readiness check is done. The system must be able
to evaluate whether the checklist is correctly answered.
Therefore, the checklist must be set up so that an evaluation
is done based on correct answers. For more information
about how to create questionnaires, see Using
questionnaires and its related topics.

Automatic approval Readiness check records include an ApprovedApproved check box
that indicates the approval status. Select the AutomaticAutomatic
approvalapproval check box for checks that should be set to
approved immediately after the assigned user completes
them. Clear this check box to require explicit approval as an
extra step.

Mandatory Select this check box for checks that must be completed by
the assigned user. Mandatory checks can't be skipped.

Add existing questionnaireAdd existing questionnaire – Add a blank row to the grid. You can then assign an existing questionnaire

by setting the fields in the following table.

CopyCopy  – Add a copy of the selected row to the grid.

DeleteDelete – Delete the selected row from the grid.

For each row that you add, set the following fields.

https://docs.microsoft.com/en-us/dynamicsax-2012/appuser-itpro/using-questionnaires
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Released data for a product when the release product structure is
used

Product acceptance

To ensure that engineering-relevant product data can easily be reused in different legal entities, you can release

complete product structures in addition to releasing products together with their engineering versions.

Therefore, you can release multilevel bill of materials (BOM) structures together with the parent in a single

release action. In this case, the BOM and the lower-level products are also released.

Engineering products are created and maintained by their engineering company in such way that they meet

quality requirements as they are designed. Each operational company that manufactures a product needs the

same product and underlying BOM. Depending on the production facility, the route might be created locally. In

this case, you won't release a route together with the product. For legal entities that will sell the products but

won't manufacture them, the BOM might not be required.

To make the process more efficient, all engineering-relevant data can be released to other operational

companies at the same time. This data includes the product structure. During the release process, you can

choose which part of the product data should be released.

For more information about engineering companies and operational companies, see Engineering companies

and data ownership rules.

Note that you can release both standard products and engineering products together with the release product

structure. During this process, the whole product structure will be released, even the BOM and route from the

company that the products are being released in.

For an example of how to release a product, see Release an engineering product to a local company

The following data is included in the release of engineering products:

Product dataProduct data – A new released product is created.

Engineering version dataEngineering version data – The engineering version and its data are created or updated. Note that if you

release the same engineering version again to an operational company, the engineering data will be

overwritten.

Engineering attr ibutesEngineering attr ibutes  – The engineering attributes and their values are created or updated.

Engineering bill of mater ialsEngineering bill of mater ials  – The engineering BOM and its lines can be created or updated. For more

information about data ownership, see Product owners.

Engineering routesEngineering routes  – The engineering routes and their operations can be created or updated. For more

information about data ownership, see Product owners.

Engineering documentsEngineering documents  – The engineering documents that are connected to the engineering version are

created or updated.

When you turn on engineering change management on your system, the release product structure is available.

In addition, standard products will include their BOMs and routes when they are released.

Product acceptanceProduct acceptance is a key parameter that influences the release process. You can set this parameter for each

company by going to Engineering change management > Setup > Engineering change managementEngineering change management > Setup > Engineering change management

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/engineering-change-management/release-product-structure.md
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Release policies

Create and manage product release policies

parametersparameters . For more information, see Engineering change management parameters.

Each release of engineering products starts when somebody from the engineering company selects a product to

release. When the Product acceptanceProduct acceptance parameter is set to Automatic, the user at the engineering company

decides which product data should be automatically released to the operational companies. The product will

then automatically be released to the companies that are selected in the release wizard.

Each release of engineering products starts when somebody from the engineering company selects a product to

release. When the Product acceptanceProduct acceptance parameter is set to Manual, the user at the engineering company

decides which product data should be released to the operational companies. A user from each operational

company then reviews the product data and decides whether to accept the release. The user at the operational

company can set the following options when the data is received:

If the products (updates) aren't relevant for the operational company, the user can choose not to accept the

release.

The user can change the item template for new products.

The user can choose whether the product should be released together with their BOMs and/or routes, and

whether they should be released as approved and active.

The user can change the effective-from dates of the products.

For an example of how to accept a product, see Review and accept the product before you release it in the local

company.

For standard products, you can release from any legal entity to any other legal entity. For engineering products, the only

legal entity that you can release from is the engineering company.

Not all operational companies need the same product data. In general, operational companies that manufacture

engineering products require a BOM, whereas operational company that only sell engineering products don't

require a BOM. You can use release policies to establish the parameters that are used for the release of products.

For engineering products, the release policy is assigned in the engineering product category, and the field is

mandatory. For standard products, the policy is assigned to the shared product, and the field is optional.

For more information about engineering product categories, see Engineering versions and engineering product

categories.

During the release process, you can influence the settings.

To work with product release policies, go to Engineering change management > Setup > product releaseEngineering change management > Setup > product release

policiespolicies . Then follow one of these steps.

To create a new policy, select NewNew  on the Action Pane, and then set the fields as described in the following

subsections.

To edit an existing policy, select it in the list pane, select EditEdit on the Action Pane, and then set the fields as

described in the following subsections.

To delete an existing policy, select it in the list pane, select EditEdit on the Action Pane, and then, on the GeneralGeneral
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Name Enter a name for the policy.

Description Enter a description of the policy.

General FastTabGeneral FastTab
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Product type Select whether the policy applies to products of the Item or
Service type. You can't change this setting after you save the
record.

Apply templates Select one of the following options to specify whether and
how product release templates should be applied when the
policy is used:

Active Use this option to help maintain your release policies. Set it
to Yes for all release policies that you use. Set it to No to
mark a release policy as inactive when it isn't used. Note that
you can't inactivate a release policy that is assigned to an
engineering product category, and you can delete only
inactive release policies.

All products FastTabAll products FastTab

NOTENOTE

FastTab, make sure that the ActiveActive option is set to No. Then select DeleteDelete on the Action Pane.

Set the following fields on the header of a product release policy.

Set the following fields on the GeneralGeneral  FastTab of a product release policy.

AlwaysAlways – A template released product must always
be used for releases. If you select this option, use the
All productsAll products  FastTab to specify the template that is
used for each company that you release to. If you
don't specify a template for each company that is
listed on the All productsAll products  FastTab, you will receive
an error when you try to save the policy.

OptionalOptional – If a template released product is
specified for a company that is listed on the AllAll
productsproducts  FastTab, that template will be used when
you release to that company. Otherwise, no template
will be used. If you select this option, you can save
the policy without assigning templates to all
companies. (No warning will be shown.)

NeverNever  – No template released product will be used
for any companies that you release to, even if a
template is specified for companies that are listed on
All productsAll products  FastTab. The template columns will be
unavailable.

On the All productsAll products  FastTab, add a row for each operational company that you want to use this policy to

release to. Use the buttons on the All productsAll products  FastTab to add and remove rows as you require. For each row

that you add, set the following fields.

The settings on the All productsAll products  FastTab apply to both engineering products and standard products.
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Company accounts ID Select the company that the row applies to. The parameters
on the row will apply when products are released to this
company.

Template released product Add a template for the product.

Copy BOM approval Select this check box to copy the BOM approval status to
the receiving company.

Copy BOM activation Select this check box to copy the BOM activation status to
the receiving company.

Copy route approval Select this check box to copy the route approval status to
the receiving company.

Copy route activation Select this check box to copy the route activation status to
the receiving company.

Option parameters for engineering products FastTabOption parameters for engineering products FastTab

NOTENOTE
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Template BOM When a product that has a BOM is released, the lines of the
specified template BOM will be added. This field is useful for
adding local components, such as packaging or instructions
in the local language.

Template route When a product that has a route is released, the lines of the
specified template will be added.

Copy effectivity Select whether effectivity dates should be copied from the
engineering company to the operational company when you
release products.

Automatically add to release proposal Select this check box for products that should automatically
be released on the engineering change order. In this way,
products that belong to engineering product categories that
use this release policy can automatically be released to
operational companies where this option is set up. (For more
information, see Manage changes to engineering products.)

Review each product when you release itReview each product when you release it

Every time that you add a row on the All productsAll products  FastTab, a row that has a matching Company accounts IDCompany accounts ID

value is also created on the Option parameters for engineering productsOption parameters for engineering products  FastTab. Then, if you remove a

row from the All productsAll products  FastTab, the row that has a matching Company accounts IDCompany accounts ID value is also removed

from the Option parameters for engineering productsOption parameters for engineering products  FastTab.

For each row that is shown on the Option parameters for engineering productsOption parameters for engineering products  FastTab, set the following

fields.

The settings on the Option parameters for engineering productsOption parameters for engineering products  FastTab apply only to engineering products.



Product owners and product releases
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When engineering products that have BOMs or routes are released, the parameters will be set to default values,

as indicated in the release policy. As a user, you can influence this behavior on the releasing side when you use

the release product structure.

To release engineering products, on the Released productsReleased products  page, select the products to release, and then select

Release product structureRelease product structure to open the release wizard. The Select engineering products to releaseSelect engineering products to release page

shows the products. Select a single product, and then select Release detailsRelease details  to review the release details for the

product.

On the Release detailsRelease details  page, you can change the value of the Receive BOMReceive BOM, Copy BOM approvalCopy BOM approval , CopyCopy

BOM activationBOM activation, Receive BOMReceive BOM, Copy route approvalCopy route approval  and Copy route activationCopy route activation fields. In the push-pull

scenario, you can change the value of the same fields on the receiving side, provided that the BOM and route are

released.

Because product owners know which legal entities need their products, a product can be released only by the

members of that product's product owner group. Other users can't release products that they don't own.

This behavior applies only when a product is directly selected for release. Products that are part of another

product's structure via a BOM can be released by non-owner users when they release the parent product,

provided that they own the parent product.

For example, product X is assigned to the Design cabinets product owner group. Product X is also part of the

BOM of product Y, which is assigned to the Design speakers product owner group. If a user from the Design

speakers product owner group releases product Y and its BOM, product X will be released together with product

Y.

For more information, see Product owners.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Mixed mode manufacturing

Manufacturing principles

This topic gives an overview of the production processes. It describes the various stages of production orders,

batch orders, and kanbans, from order creation to closing of the financial period.

The production of products, a process that is also known as the production life cycle, follows specific steps that

are required to complete the manufacture of an item. The life cycle begins with the creation of the production

order, batch order, or kanban. It ends with a finished, manufactured item that is ready for either a customer or

another phase of production. Each step in the life cycle requires different kinds of information to complete the

process. As each step is completed, the production order, batch order, or kanban shows a change in the

production status. Different types of products require different manufacturing processes.

The Production controlProduction control  module is linked to other modules, such as Product information managementProduct information management,

Inventor y managementInventor y management, General ledgerGeneral ledger , Warehouse managementWarehouse management, Project accountingProject accounting, and

Organization administrationOrganization administration. This integration supports the information flow that is required to complete the

manufacturing of a finished item.

The production process is typically influenced by the cost accounting and inventory valuation methods that are

chosen for a specific production process. Supply Chain Management supports both actual cost (first in, first out

[FIFO]; last in, first out [LIFO]; moving average; and periodic weighted average) and standard cost methods. Lean

manufacturing is implemented based on the backflush costing principle.

The choice of the cost measurement methods also defines the requirements for reporting about material and

resource consumption during the production process. Typically, actual cost methods require accurate reporting

on the job level, whereas periodic costing methods allow for less granular reporting of material and resource

consumption.

Different products and production topologies require the application of different order types. Supply Chain

Management can apply the various order types in a mixed mode. In other words, all order types can occur

during the end-to-end process of producing one finished product.

Production orderProduction order  – This is the classic order type to produce a specific product or product variant in a given

quantity on a specific date. Production orders are based on bills of materials (BOMs) and routes.

Batch orderBatch order  – This order type is used for process industries and discrete processes where the

manufacturing conversion is based on a formula, or where co-products and by-products can be end

products, either in addition to or instead of the main product. Batch orders use FormulaFormula type BOMs and

routes.

KanbanKanban – Kanbans are used to signal repetitive lean manufacturing processes that are based on production

flows, kanban rules, and BOMs.

ProjectProject – A manufacturing project combines products and services with a given schedule and budget. The

manufacturing part of a project can be delivered through any of the other order types.

To select the manufacturing principle that best applies to a particular product and related market, you must

consider the requirements of production and logistics, and also customer expectations about delivery lead

times.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/production-process-overview.md


Overview of the production life cycle

Make to stockMake to stock – This is the classic manufacturing principle, where products are produced for stock, based

on forecast or minimum stock refill (the latter is typically calculated based on forecast or historic

consumption).

Make to orderMake to order  – Standard products are made to order or finished to order. Although pre-production might

be done by using the Make to stock principle, expensive steps of the value chain, or steps that create variants,

are triggered by a sales order or transfer order.

Configure to orderConfigure to order  – As for the Make to order principle, the final operations of the value chain are made to

order. The actual product variant that is produced isn't predefined but is created at the time of order entry,

based on the configuration model of the sales product. The Configure to order principle requires a certain

level of process unification for a given product line.

Engineer to orderEngineer to order  – Engineer to order processes are typically addressed by a project and usually start with

the engineering phase. During the engineering phase, the actual products that are required fulfill the order

are designed and described. Production orders, batch orders, or kanbans can then be created to produce the

products.

The following steps in the production life cycle can occur for all order types of mixed mode manufacturing.

However, not all of them are represented as an explicit order status.

1. CreatedCreated – You can create a production order, batch order, or kanban manually, or you can configure the

system to generate them based on various demand signals. Master planning creates production orders,

batch orders, or kanbans by firming planned orders. Other demand signals are sales orders or pegged

supply signals from other production orders or kanbans. For fixed-quantity kanbans, demand signals are

generated when kanbans are registered as empty.

2. EstimatedEstimated – You can calculate estimates for material and resource consumption. The estimation

generates inventory transactions for raw materials that have a status of On orderOn order . The receipts for main

products, co-products, and by-products are generated when production orders or batch orders are

estimated. If the BOM contains lines of the Pegged supplyPegged supply  type, purchase orders for materials or

subcontracted operation services are generated and pegged to the production order or batch order. Items

or orders are reserved according to the reservation strategy of the production order, and the price of the

finished goods is calculated based on parameter settings.

3. ScheduledScheduled – You can schedule production based on operations, individual jobs, or both.

Operations schedulingOperations scheduling – This scheduling method provides a rough, long-term plan. By using this

method, you can assign start and end dates to production orders. If the production orders are

attached to route operations, you can assign them to cost center groups.

Job schedulingJob scheduling – This scheduling method provides a detailed plan. Each operation is broken down

into individual jobs that have specific dates, times, and assigned operations resources. If finite capacity

is used, jobs are assigned to operations resources based on availability. You can view and change the

schedule in a Gantt chart.

Kanban scheduleKanban schedule – Kanban jobs are scheduled on the kanban schedule board or automatically

scheduled based on the automatic planning configuration of the kanban rules.

4. ReleasedReleased – You can release the production order or batch order when the schedule is finished and the

material is available to be picked or prepared. The material availability check helps the shop floor

supervisor assess the availability of material for the production orders or batch orders. You can also print

the production order documents, such as the pick lists, job card, route card, and route job. When the

production order is released, the status of the order changes to indicate that the production can begin.

When warehouse management is used, release of the production order or batch order releases the

production BOM lines to warehouse management. Warehouse waves and warehouse work are then

generated according to the setup of the warehouse.



5. PreparedPrepared/PickedPicked – When all materials and resources have been staged at the production location, the

production BOM lines or kanban lines are updated to a status of PickedPicked. Pegged supply orders and

related warehouse work are typically completed at this stage. The kanban cards or job cards that are

required to report production progress should be assigned and printed.

6. Star tedStar ted – When a production order, batch order, or kanban is started, you can report material and

resource consumption against the order. The system can be configured to automatically post the material

and resource consumption that are allocated to the order when the order is started. This allocation is

known as preflushing, forward flushing, or autoconsumption. You can manually allocate materials to

production orders or batch orders by creating additional picking list journals. You can also manually

allocate labor and other route costs to the order. If you're using operations scheduling, you can allocate

these costs by creating a route card journal. If you're using job scheduling, you can allocate the costs by

creating a job card journal. Production orders or batch orders can be started in batches of the requested

final quantity. Within a production order, batch order, or kanban, the jobs that are created can be started

and reported separately through journals, the manufacturing execution terminal (MES Terminal), or the

kanban boards.

7. Report progress/CompleteComplete jobs – Use the MES Terminal, production journals, kanban boards, or mobile

scanning capabilities to report the production progress by job or resource. Material and resource

consumption will be posted, and the status of the related kanbans, production orders, and batch orders

might be updated to ReceivedReceived or Repor ted as finishedRepor ted as finished. Put-away work for the warehouse might be

created, depending on the warehouse configuration.

8. Repor ted as finishedRepor ted as finished (the product receipt) – When a production order or batch order is reported as

finished, the quantity of the finished goods that were completed is updated in inventory. This quantity

includes the quantity of relevant co-products and by-products. If you're using work-in-process (WIP)

accounting, a ledger journal is generated to reduce the WIP accounts and increase the inventory of the

finished goods. When the cost of a production order is calculated, the actual cost of the production is

posted. If the material and labor costs that are associated with a production aren't already allocated in a

journal or by preflushing, they can be automatically allocated through back-flushing. Allocation through

back-flushing involves the post-deducting of inventory transaction processes. If the production order is

completed, select the End jobEnd job check box to change the remaining status to EndedEnded. Otherwise, leave the

field empty to enable reporting of additional quantities that are produced.

9. Quality assessmentQuality assessment – A product receipt can trigger the creation of quality orders, depending on the

configuration of test processes and the quality rules that are established for specific products. Because a

quality order can update the inventory status or the batch attributes of the tested products, quality

assessment is a mandatory process in many industries.

10. Put awayPut away  and Ship to orderShip to order  – After product receipt and quality assessment, optional put-away work

directs the received products to the next point of consumption, to a finished goods warehouse, or to a

shipment zone if there are ship-to-order requirements.

11. EndedEnded – Before production is ended, actual costs are calculated for the quantity that was produced. All

estimated costs of material, labor, and overhead are reversed and replaced with actual costs. If you select

the End jobEnd job check box when you run the cost calculation, the production order status changes to EndedEnded.

This status prevents any additional costs from being posted to a completed production order.

12. Per iod closurePeriod closure – Some cost accounting principles, such as periodic average, back-flush costing, FIFO, or

LIFO, require periodic activities to close the inventory or financial period. Typically, the system tries to

report all material and resource consumption, and also corrections of inventory and scrap, before the

periods are closed. This reporting is typically done by using inventory movement journals or adjustment

journals. The goal is to assess the economic performance of operating units per period. In some cases,

when long-running production orders are used that span the financial reporting periods, production

journals are used to report the production progress and resource consumption by the end of the period.
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Production feedback
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Lean manufacturing overview
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Supply policies

This topic provides information about mixed mode planning. In mixed mode planning, you can model your

supply chain based on the material flow. Dynamics 365 Supply Chain Management makes sure that the material

flow follows your models, regardless of the supply policy that is selected (kanbans, production orders, purchase

orders, batch orders, or transfer orders).

You can select your overall strategy for supplying a product, regardless of the product structure.

For example, you can have kanban control in the assembly, where materials are sourced for the assembly area

by production orders, kanbans, transfers, batch orders, or any combination that is appropriate for the

characteristics of your supply chain, but you can still have full visibility across supplies. This capability leads to

optimized supply chain processes and enhanced visibility into your supply chain.

The granularity of the supply policies that are used in master scheduling depends on the storage dimensions

that are enabled as coverage dimensions. To enable master scheduling to control the replenishment and supply

of different types of locations (for example, by separating the production floor for different production units, or

by separating different types of material and finished goods warehouses), we recommend that you enable Site

and Warehouse as coverage dimensions. Alternatively, Warehouse can be omitted as a coverage dimension. In

that case, when you use advanced warehouse management, all movements inside a warehouse are controlled

by warehouse work, whereas all movements across warehouses can be controlled by withdrawal kanbans.

Mixed mode planning controls how a product is supplied and, based on the supply, how derived requirements

(consumption of items from a bill of materials [BOM]) are issued. Based on the order type, the system

automatically sources materials to match the requirements.

Supply policies can be defined at the product level or at any granularity that supports your requirements. You

define the granularity of supply policies on the Default order settingsDefault order settings  page.

Supply policies can be controlled by product, item dimensions (configuration, color, and size), site, and

warehouse. This setup is done on the Item coverageItem coverage page.

The default order type controls what order master planning generates.

Regardless of how the supply chain is modeled, Supply Chain Management supports your mix of supply

policies. You can have production orders that are sourced from kanbans. Alternatively, you can have a batch

order that requires a product that is supplied by transfers or by kanbans.

Supply Chain Management makes sure that the material flow follows the model.

The warehouse for picking material is assigned dynamically at run time, after the supply policy has been

defined.

Typically, kanbans aren't created for future dates, because a kanban has a short life cycle. To maintain full

visibility into the supply chain, we have introduced the new planning concept of a “planned kanban,” which is

used to calculate derived requirements and helps guarantee that the requirements are sourced based on the

same logic that is used when the actual kanban is created.

The same logic is present for all other supply policy types. Therefore, long-term materials planning is based on

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/mixed-mode-plan.md


Materials allocation cross-supply policy – Resource consumption on
BOMs

Process manufacturing – The production type
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the same logic that you expect to run with the actual orders after production and supply are approved.

Resource consumption is an important functionality. Resource consumption enables a warehouse for picking

materials to be selected dynamically, based on the supply policy (order type), and also makes maintenance of

base data easier.

Resource consumption requires that the warehouse that materials are picked from be assigned based on the

way that the product is supplied. In other words, at run time, the system finds the resources that should be used

for manufacturing. Based on those resources, the system then finds the picking warehouse.

For work that is independent of a supply policy, you don't have to change information on the BOM if the supply

is changed. For ad-hoc changes, Supply Chain Management makes sure that materials are sourced from the

right warehouse.

For full flexibility in mixed mode, we recommend that you use production type BOMs for all products. You can

then use production orders, kanbans, transfer orders, or purchase orders to supply a product. For process

manufacturing, you must use a production type of FormulaFormula, Co-productCo-product, By-productBy-product, or Planning itemPlanning item.

Kanbans and production orders can't be used for these production types.
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Subcontracting of route operations

This topic explains how subcontracted operations are managed in Dynamics 365 Supply Chain Management. In

other words, it explains how production operations that are allocated to a resource are managed by a vendor.

In production processes, work can be done by resources that are owned or administered by vendors. Typically,

vendor resources are used to level periodic excess demand that surpasses the available capacity of a company's

own resources. The vendor might also be able to offer specific resource capabilities or resources at a lower price.

Depending on the vendor resources that are used in a production process, a route often has additional logistic

requirements, because the material and semi-finished products must first be transported to the vendor's site.

Then the result of the subcontracted operation must be transported either to the location that is allocated to the

next operation or to a finished goods warehouse.

When subcontracting operations or activities are used, they affect all stages of operations, from the definition of

the operations that are required in production, costing, forecasting, planning, and scheduling, to the

management of logistics for materials, semi-finished products, and finished goods. Finally, these resources

require their own processes for accounting and cost control.

For internal resources, a fixed cost rate is typically allocated for a period. By contrast, the cost of subcontracted

resources is based on the purchase price of the related service. The service is defined as another product, and is

used to drive the procurement and purchase processes for a given subcontracted operation.

Currently, there is no explicit concept of semi-finished products in Supply Chain Management. For a production

order that requires more than one operation in order to transform raw materials into a finished good, the

finished good is posted back into inventory only in the last operation. The semi-finished products that the earlier

operations produce are accounted in work in progress (WIP), but they aren't posted or tracked in inventory.

Although you can split the routes and bills of materials (BOMs) into multiple smaller units, this approach

increases the number of products, BOMs, and routes that must be managed.

There are two methods for modeling subcontracting work for production operations. These methods differ in

the way that the subcontracting process can be modeled, the way that semi-finished products are represented in

the process, and the way that cost control is managed.

Subcontracting of route operations in production orders or batch orders

Subcontracting of production flow activities in a lean production flow

The service product must be a stocked product, and it must be part of the BOM.

This method supports first in, first out (FIFO) or standard cost.

Semi-finished products are represented by the service product in the process.

Cost control allocates the costs that are associated with subcontracted work to the material costs.

The service is a non-stocked service product, and it isn't part of the BOM.

This method uses purchase agreements as service agreements.

This method uses backflush costing.

This method allows for aggregated and asynchronous procurement. (Material flow is independent of

the procurement process.)

Cost control allocates subcontracted work in its own cost breakdown block.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/manage-subcontract-work-production.md


Subcontracting of production flow activities

Modeling subcontracting in a production flowModeling subcontracting in a production flow

To use subcontracting of route operations for production or batch orders, the service product that is used for the

procurement of the service must be defined as a product of the Ser viceSer vice type. Additionally, it must have an item

model group that has the Stocked productStocked product option under Inventor y policyInventor y policy  set to YesYes . This option defines

whether a product is accounted as inventory on product receipt (Stocked productStocked product = YesYes ), or whether the

product is expensed on a profit and loss account (Stocked productStocked product = NoNo). Although this behavior might seem

contradictory, it's based on the fact that only products that have this policy will create inventory transactions

that can be used in cost control to calculate planned cost and determine the actual cost when a production order

is ended.

To be considered in planning and cost calculation, the service must be added to the BOM. The BOM line must be

of the VendorVendor  type, and it must be allocated to the route operation that the service is allocated to. This route

operation must have a costing resource and resource requirement that point to a resource of the VendorVendor  type

that connects the operation and the related service to the corresponding vendor account.

When this configuration is used, a purchase order is created for the related service product, based on estimation

of a production order. The purchase order of the service is used as an anchor for the subcontracted operations.

The subcontracted work can be managed through the Subcontracted workSubcontracted work list page in Production control. The

subcontracted work is used to ship raw material and, eventually, a semi-finished product to the vendor in

preparation for the operation. It's also used to receive the resulting product of the subcontracted operation in

item arrival, where the service product is used to identify the arrival of the semi-finished product. When the

purchase order line is received, the production operation is updated as completed.

A production order can have many operations, and each operation can be allocated to a different vendor.

Therefore, an end-to-end production order might trigger multiple purchase orders.

The lean manufacturing solution models the subcontracting work as a service that is related to an activity of a

production flow (Task guide topic). Therefore, this type of subcontracting is also referred to as activity-based

subcontracting. A special cost group type, Direct outsourcingDirect outsourcing, has been introduced, and the subcontracting

services aren't part of the BOM of the finished goods. When you use lean manufacturing, all activities are

defined by kanbans that can be related to one or multiple production flow activities. So far, that explanation

sounds just like an explanation of production orders. However, whereas production orders must always end with

a finished product, you can create kanbans to supply a semi-finished product. You don't have to introduce a new

product and BOM level.

Because kanban rules can be very dynamic, you can model different variants of supply for the same product on

a production flow. When you use lean subcontracting, the material flow and the financial flow are strictly

separated. All material flow is represented by kanban activities. The purchase orders for the service products

and the receipt postings of those services can be automated, based on the status of kanban jobs in the

production flow. Kanban jobs can be started and completed even before the purchase orders are created. The

subcontracting documents (purchase order and purchase receipt of the service) can be aggregated by period

and service. Therefore, the number of purchase documents and lines can be kept small, even in highly repetitive

operations where vendors provide subcontracted services in a single-piece flow.

In a lean production flow, a process activity can be defined as subcontracted when it's allocated to a work cell

(resource group) that has a single vendor resource. When a work cell is subcontracted, the related process

activities must be linked to an active purchase agreement line that contains the service item and the price of the

service. The service agreement of the activity also defines the calculation ratio between the product quantity of

the kanban job and the resulting service quantity. You can select whether the service quantity is calculated based

on the number of jobs, the good product quantity that is reported on the jobs, or the total product quantity (this

total quantity includes scrapped products).

Transfer activities can also be defined as subcontracted. This definition occurs implicitly when you select the



Backflush costingBackflush costing

Material supply for subcontracted operations

responsible party for the shipping in the transfer activity. When you select ShipperShipper  or RecipientRecipient, if the

corresponding source or target warehouse is a vendor-managed warehouse, the activity is considered

subcontracted. When you select Carr ierCarr ier , the activity is always subcontracted. Like subcontracted process

activities, a subcontracted transfer activity must be connected to a service agreement before the production flow

can be activated.

The cost accounting of subcontracted work is completely integrated into the costing for the lean manufacturing

solution (backflush costing). When the purchase order receipt of the service is posted, or when invoicing occurs,

the cost of the service is allocated to the production flow. For backflush costing, the variance of subcontracted

services is calculated by offsetting the subcontracting block of the standard cost of the received products against

the actual received and invoiced service quantities.

Semi-finished products and other related materials must be transferred to the location where the work is

physically performed. When you use subcontracted operations and activities, this transfer is often related to

additional transport to a vendor-operated site. By allocating material in the BOM to the subcontracted operation,

you declare that the material must be staged at the input location of the resource group for the allocated

resource. Master planning or lean replenishment then provisions the material to that location.

To model the inventory that is located at a vendor site, it's a best practice in the industry to define a vendor-

managed warehouse. You can easily define a vendor-managed warehouse by creating a new warehouse and

assigning the vendor account. To document that material must be transferred to the vendor before an operation

can be performed, you should allocate the vendor-managed warehouse to the input warehouse of the resource

group that holds the resource.

To replenish material at this warehouse, you can use multiple strategies:

Transfer orders

Transfer journals

Withdrawal kanbans

Direct purchase to the vendor location

Semi-finished products are the exception to this rule. To transfer semi-finished products, you're limited to these

options:

For production and batch orders, semi-finished products can only be transferred logically by using the

Picking list journal from the Subcontracted workSubcontracted work list page. This journal will create a delivery note

document that can be used to transfer semi-finished and raw material to the vendor.

For subcontracted operations in production flows, the transfer of semi-finished products is documented by

the receipt of withdrawal or production kanbans at the vendor location. To model an explicit transfer activity,

you can end a production kanban with an additional transfer activity.

Note:Note: A production route for a single production order can't cross multiple sites. This rule also applies to the

subcontracted work. Therefore, the warehouses that represent the vendor-managed material locations must be

defined in the same site as the internal resources that are used in the route. Although production flows can cross

sites, they can't transport semi-finished products from one site to another, because that operation implies a

change of cost context.

Typically, the output warehouse and location of a subcontracted resource group are directly allocated to the

warehouse and location of the next step of the operation in the route or production flow. This setup helps reduce

the amount of job reporting that occurs or the number additional transfer operations that must be modeled.
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Required baseline setup in other modules

Required calendar and resource setup

Required production parameters setup

Required journal name identification

This article provides information about setup requirements before you can work with Production control.

Production control is integrated with features in other modules. This interconnectivity lets you change

production orders and make sure that they are automatically updated in all other related processes and

calculations in the system. The following setup processes are listed in the order that you should complete them

in.

Information in other modules must be set up before you can work with Production control. This setup includes

the following tasks:

Set up general company information.

Set up the general ledger.

Define item groups.

Set up ledger accounts for item groups.

Set up the inventory item table in Inventory management.

Create bills of materials (BOMs) and BOM versions in Inventory management.

Before you use Production control, open Organization administration, and create and define the calendar and

operations resources in the following order :

1. Working time templatesWorking time templates  – Set up working time templates to define the times that are available for

production scheduling.

2. CalendarsCalendars  – Set up working time calendars to define the days of the year that are available for production

scheduling.

3. Resource groupsResource groups  – Set up resource groups to group the operations resources, so that you can get an

overview of any free capacity when you run scheduling. You don't have to set up resource groups before you

set up operations resources. However, we recommend that you understand how to group resources when

you set up Production control.

4. ResourcesResources  – Set up operations resources to define the resources that are used to complete the production

process and plan for capacity.

Production control parametersProduction control parameters  – Set up basic production parameters to define how the system handles and

processes production orders. Define how production orders are created, estimated, scheduled, and consumed.

You can also select what kind of feedback you want and how cost accounting is done.

Production journal namesProduction journal names  – Specify the production journal names that are used to record and post

transactions.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/production-set-up-requirements.md


Setup if you use operations

Setup if you use routes

Optional advanced settings

NOTENOTE

Operations represent the specific activities that are completed to produce the finished product. Note:Note: You must

know the types of activities that are required in order to produce your item, and the order and priorities of those

activities. You must also know which resources are involved, and how many.

1. OperationsOperations  – Set up operations to represent the tasks that must be completed to produce the finished item.

2. RelationsRelations  – Set up operation relations to establish detailed properties. To define operation relations, click

RelationsRelations  on the OperationsOperations  page.

If you're working with routes, operations must be defined for every production route that you set up. The route

represents the path that the item takes from operation to operation, from the start of the production process to

the end.

1. Cost categoriesCost categories  – Set up cost categories to define the cost per hour of specified processes and setup times.

2. Cost groupsCost groups  – Set up cost groups to create and maintain different types of costing.

3. Route groupsRoute groups  – Set up route groups to define parameters that are related to groups of routes. You must set

up route groups before you can create production routes.

4. RoutesRoutes  – Set up production routes, and define default settings to control scheduling, costing, and pricing of

route operations, and to control progress reporting.

5. Route versionRoute version – Set up route versions to enable item variations in production.

1. Production groupsProduction groups  – Set up production groups to establish relationships between the production order

and ledger accounts. The ledger accounts are used to post or group orders for reporting.

2. Production poolsProduction pools  – Create production pools to group production orders so that you can process urgent

production orders, or delete and post groups of orders.

3. Proper tiesProper ties  – Define properties to create special attributes that you can assign to your resources to control

the order of productions. These attributes are connected to the working time template.

Can you tell us about your documentation language preferences? Take a short survey.
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Bills of materials

Formulas, co-products, and by-productsFormulas, co-products, and by-products

BOMs in the product lifecycleBOMs in the product lifecycle

This topic provides information about bills of materials (BOMs) and formulas, which are a central part of the

definition of products and product variants. BOMs and formulas specify the required materials or ingredients for

a specific product. Formulas also specify the co-products and by-products that are received in a specific

production context.

A bill of materials (BOM) defines the components that are required in order to produce a product. The

components can be raw materials, semi-finished products, or ingredients. In some cases, services can be

referenced in a BOM. However, BOMs typically describe the material resources that are required.

When it's combined with a route or production flow that describes the operations and resources that are

required in order to build a product, the BOM forms the foundation for calculating the estimated cost of the

product.

A BOM is an individual entity that is described by the following information:

BOM ID

BOM name

The BOM lines that describe the components and ingredients

The BOM versions, which define the product and period that the BOM can be used for

A single BOM describes a single level that is identified by a unique ID. Components might have their own BOMs

that are referenced by BOM versions. You can display and edit the complete hierarchy of BOMs for a specific

product in the BOM designer.

A formula is a subtype of BOM that is typically used for process manufacturing. In addition to components and

ingredients, a formula describes co-products and by-products. In the actual version, the definition of co-

products and by-products for the formula requires the formula version. A formula is typically defined for one

specific finished product (a formula or planning item) that is defined in the formula version.

In the product lifecycle, many types of BOM might be created for various reasons:

Sketching/Draft BOMSketching/Draft BOM – This BOM gives a draft estimation of required materials in an early design phase

and helps you do a rough estimate of cost and estimated product attributes. This BOM isn't usually used in

enterprise resource planning (ERP).

Engineering BOMEngineering BOM – This BOM is typically used when you design products that are based on existing

product portfolios. Engineering BOMs are structured to simplify the design process and group complex

products into engineering modules. For simple products, it might be possible to engineering BOMs for the

actual production process. However, for other products, the engineering BOM must be converted to an actual

production BOM. Engineering BOMS are typically represented by phantoms in the BOM hierarchy. Although

engineering BOMs can be used for the planning and execution of manufacturing operations, this approach

can lead to inefficiencies, especially in repetitive operations where many orders are created.

Planning BOMPlanning BOM – This BOM is used to do planning for material requirements. The demand of components

and ingredients is calculated based on the demand of the finished products. Like costing BOMs, planning

BOMs might represent a specific mix of material that is used in a period.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/bill-of-material-bom.md
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BOM and formula versions

Approval of BOM and formula versionsApproval of BOM and formula versions

Activation of the default BOM or formula versionActivation of the default BOM or formula version

Product change with case managementProduct change with case management

Alternative BOM versionsAlternative BOM versions

Production BOMProduction BOM – This is the actual BOM that is used for a specific production. A production BOM must

take into account the actual resources that are used to produce the product. When a production order, batch

order, or kanban is created, the multiple levels of BOMs that are represented by phantoms are collapsed into

one level and distributed over the operations for the order.

Costing BOMCosting BOM – This BOM is used to calculate the estimated cost of a product. For example, you can use a

costing BOM when standard cost is used or the estimated planned cost of a given product is calculated.

Costing BOMs can refer to a specific mix of materials and resources that is expected to be used. Therefore,

you can use the costing BOM to create a representative estimated cost for a period and help avoid variances

over time.

The types of BOM that are actually used in an implementation depend on the implementation, and also on the

business scenarios and requirements. In simple implementations, a planning BOM, production BOM, and costing

BOM can be modeled as one BOM. In environments that have frequent engineering changes and multiple

alternative routes, a larger set of BOM types will probably be required.

Each BOM and formula can be separately approved or unapproved. Typically, approval of a BOM or formula

occurs when the first relevant BOM version is approved. However, in some business scenarios, these approvals

might be different steps in the process and might involve different process owners.

Note that, if a BOM is unapproved, all related BOM versions are also unapproved.

To relate a specific BOM or formula to a product variant that can be produced, you must create a BOM version or

formula version. The validity of BOM versions and formula versions can be constrained by period, quantity, site,

specific product dimensions, and other criteria. Formula versions have additional important attributes, such as

yield, co-product and by-product definitions, and the cost distribution instructions for the formula.

Before a BOM version can be used in the planning or manufacturing process, it must be approved. When a BOM

version is approved, the related BOM can also be approved, depending on the user's selection and

authentication rights. Note that a BOM version can be approved only if the related BOM itself is approved.

To set a specific BOM or formula as the default BOM version or formula version that will be used by master

planning or used to create of production orders, you must activate the version. When a version is activated, the

uniqueness of the version for the given constraints (for example, period, site, or quantity) is verified. You receive

an error message if the version that you're trying to activate conflicts with a version that is already active. You

must then either inactivate the conflicting version or modify the version constraints (usually the period) to

prevent an ambiguous activation.

The product change case for approval and activation of new or changed BOMs and BOM versions provides an

easy way to see an overview of the BOM version constraints. You can also approve and activate all BOMs and

formulas that are related to a specific change for one activation date.

Sometimes, the active BOM version or formula version should not be used in forecasts, sales, or a parent

product. In this case, you can select a specific approved BOM as part of the requirement (forecast line, sales line,

or BOM line) if an approved BOM version or formula version exists for the alternative BOM or formula.

When planned orders, production orders, or kanbans are created, the planner or shop floor supervisor can use

any approved BOM version that is valid on the requested planned production date to plan for or produce a



BOM and formula lines

ItemItem

PhantomPhantom

Pegged supplyPegged supply

VendorVendor

NOTENOTE

specific product. The BOM version that is used doesn't have to be activated as the default BOM version.

A BOM line is created for each material, service, or ingredient. The line defines the planned consumption of the

specified product variant and also defines the various attributes that are related to the planned consumption.

BOM lines can have the following line types: ItemItem, PhantomPhantom, Pegged supplyPegged supply , VendorVendor .

Select the ItemItem line type for materials or services that are directly consumed, and that don't require further

explosion or pegged supply.

Select the PhantomPhantom line type when you want to explode any lower-level BOM items that are contained on the

BOM line. In Master scheduling, in planned cost calculation, or on estimation of a production order that uses

BOM lines of the PhantomPhantom type, the parent BOM line that refers to a product variant that has a phantom BOM

is replaced by the component items that are listed as BOM lines in that BOM, as determined by the applicable

active BOM version of that product variant. If the product variant has an applicable active route, the operations

of that route are merged into the parent route.

Note that phantoms are typically used to simplify the engineering process. Extensive use of phantom BOMs in

many levels has an effect on performance, especially in highly repetitive manufacturing scenarios. To improve

performance, you should avoid deep hierarchies of phantoms. Instead, use pre-exploded production BOMs and

routes.

Select the Pegged supplyPegged supply  line type when you want to create a subproduction, a BOM line event kanban, or a

direct purchase order for any product variant that the BOM line references. The subproduction, event kanban, or

purchase order is created when you estimate the production order. The required item quantities are

automatically reserved for the consuming production order.

Select the VendorVendor  line type if the production process uses a subcontractor, and you want a subproduction or

purchase order to be created automatically for the subcontractor.

Note about subcontracted operations in a BOM:Note about subcontracted operations in a BOM: The service or work that is performed by the

subcontractor must be created as service item that is tracked in inventory. You must attach the service item to

the parent item as a BOM line. The route must contain an operation that is assigned to the subcontractor's

operations resource.
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Analyzing a BOM structure by using the BOM designer

Selecting a BOM and route

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Product dimensions If the selected finished product is a product master, you can
define the active product dimensions for the main selection.
Note:Note:  If you open the BOM designer for a product that isn't
a product master, no product dimensions can be selected in
the FilterFilter  dialog box.

This topic describes how you can use the BOM designer page to design and work with tree structures for bills of

materials (BOMs). You can click Setup to select different configurations and specify what information appears on

the lines of the tree.

When you open the BOM designerBOM designer  page from the Released productsReleased products  page, it displays the hierarchy of bills

of materials (BOMs) that are active and approved for the selected item, the default order site of the item, and the

actual date.

Click FilterFilter  to change the initial selection in the view. By setting the display principle to Selected/Active orSelected/Active or

SelectedSelected, you can select individual BOM or route versions to use in the view. You can select non-approved and

non-active BOM versions to show or maintain in the BOM designer.

Note:Note: If you open the BOM designer from the Bills of mater ialsBills of mater ials  list page, it doesn't display route information.

Currently, the selection of a BOM or route version is a property of the BOM and route version, and applies to all

instances of the BOM designer.

The following sections describe the functionality that is available on the various tabs of the BOM designer.

The BOM designer has two sections:

The tree view of the BOM structure.

The details section, which shows details of the selected data. When you select a node in the tree view, the

FastTabs in the details section are updated based on that node:

BOM line detailsBOM line details  – Shows the details of the BOM line that is selected in the tree view.

Item dataItem data – Shows the details of the main item or the item that is used in the selected node. You can

click Edit released productEdit released product to maintain the selected item.

BOMBOM – Shows the header of the BOM that is related to the selected node.

RouteRoute – Shows the header of the route that is related to the selected node.

Route operationsRoute operations  – Shows a preview of the operations for the route. When a BOM line that is

assigned to a specific operation is selected, the operation is marked as Component needed atComponent needed at

operationsoperations .

The filter that is applied for the BOM and route is displayed in the header of the BOM designer. You can change

the filter by using the FilterFilter  dialog box. The following table describes the fields in this dialog box.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/bom-designer-functionality.md


Site Change the site that the BOM tree is displayed for. The
default site is the default inventory site of the finished item.

Display principle Select the version display principle that applies to the current
BOM structure and the current route:

Version date Enter the version date for the BOM and route. The version
identifies which BOM version is used on a specific date, as
determined by the version dates in the BOM version setup.

From quantity Filter the versions by selecting a specific from quantity. If you
set a value, different BOM and route versions might be
selected.

Show valid only When you select the check box, the tree structure shows
only BOM lines that have valid dates. Right-click or double-
click a BOM line to open the Edit BOM lineEdit BOM line page, where
you can see the validity dates for that BOM line.

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Adding and editing BOMs and BOM lines
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BOM lines > Edit Open a dialog box where you can edit
the BOM line attributes.

This function is available when a BOM
line node is selected.

BOM lines > Delete Delete a BOM line from the selected
BOM.

This function is available when a BOM
line node is selected, and the BOM
isn't locked for editing.

BOM lines > Add before line Open a dialog box where you can
select a product variant to include
before the selected BOM line.

This function is available when a BOM
line node is selected.

When the principle is set to Active orActive or
Selected/ActiveSelected/Active, the valid BOM or route version for
this date is found.

When the principle is set to Selected/Active orSelected/Active or
SelectedSelected, you can select a BOM version or route
version by clicking BOMBOM > BOM versionsBOM versions or RouteRoute
> Route versionsRoute versions .

When you use the BOM designer to review or edit BOMs that consist of one or more levels of phantoms, the

route that is associated with the top item typically spans the complete BOM hierarchy. To simplify the overview,

you can lock the top-level route in the display by clicking ViewView  > Lock routeLock route. To unlock the route, click ViewView  >

Unlock routeUnlock route.

Use the BOM linesBOM lines  or BOMBOM functions to modify the BOM lines or BOM. When you select a node in the tree, the

type of the node determines that functions that are available.



BOM lines > Add to component BOM Open a dialog box where you can
select a product variant to include at
the end of the selected BOM.

This function is available when the
node that is selected has a selected
BOM. If this function isn't available, a
BOM version might be missing for the
selected item variant. In this case, you
can click BOMBOM > Create versionCreate version to
create the missing version for the
selected node.

BOM lines > Add after line Open a dialog box where you can
select a product variant to include after
the selected BOM line.

This function is available when a BOM
line node is selected.

BOM > Create version Create a new BOM version or BOM for
the product variant of the selected
node.

This function is available when the
BOM line node that is selected is
linked to an item that has a production
type of BOMBOM or FormulaFormula.

BOM > Calculation Open a dialog box where you can run
the cost or sales price calculation for
the selected product variant.

This function is available when the
node that is selected is related to a
BOM version.

BOM > Check Validate and check the selected BOM. This function is available when the
node that is selected is related to a
BOM version.

F UN C T IO NF UN C T IO N DESC RIP T IO NDESC RIP T IO N N O DE T Y P E  A N D C O N DIT IO N SN O DE T Y P E  A N D C O N DIT IO N S

Configuring the tree view

F IEL D GRO UPF IEL D GRO UP DESC RIP T IO NDESC RIP T IO N

BOM Use the check boxes to select the criteria that are shown in
the tree structure. The BOM designer displays the selected
criteria at the bottom of both tabs.

Route Use the check boxes to select the criteria that are shown for
the routes.

NOTENOTE

Click SetupSetup to customize the information that is shown in the tree view of the BOM designer.
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IMPORTANTIMPORTANT

Turn on the feature

Assign a production reservation policy to an item model group

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

The Override default production reservation feature lets you set a default reservation principle for each item

model group. Therefore, different reservation principles can automatically be applied for each item that is part

of a production bill of materials (BOM) or batch order formula. You can select whether each item model group

should override the default reservation principle that is set for an order, and what reservation principle should

be used instead (manual, estimation, scheduling, release, or start).

When you create a new production order or batch order, you're prompted to select the reservation principle that

should be applied to that order and all its BOM lines or formula lines. When the Override default production

reservation feature is used, some or all of the BOM or formula lines can override that reservation principle and

instead use the reservation principle that is set for the relevant item model group.

For example, if you have raw materials or ingredients that require pick work, BOM or formula lines that are

created for those products require a physical reservation, because physical reservation is a prerequisite for the

generation of warehouse work. Typically, if you want the reservation to occur automatically, you select one of

the following reservation principles: estimation, scheduling, release, or start. On the other hand, if you have

materials or ingredients that don't require pick work, because they are consumed directly from a location, you

typically select the manual reservation principle, which doesn't make any physical reservations or generate any

pick work.

Before you can use the feature, it must be turned on in your system. Admins can use the feature management

settings to check the status of the feature and turn it on. In the Feature managementFeature management workspace, the feature is

listed in the following way:

Module:Module: Production control

Feature name:Feature name: Override default production reservation

1. Go to Cost management > Inventor y accounting policies setup > Item model groupsCost management > Inventor y accounting policies setup > Item model groups .

2. Create or select an item model group.

3. On the Inventor y policiesInventor y policies  FastTab, select the Overr ide item production reser vationOverr ide item production reser vation check box.

4. In the Reser vationReser vation field, select the reservation principle for items that belong to the selected model

group. (Those items include items that are on a BOM or formula line.)

ManualManual  – Items in the model group won't automatically be physically reserved for production.

However, they can still be manually reserved as required.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/override-default-reservation-principle.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version


Example: Using reservation principles in a bulk/pack scenario

NOTENOTE

EstimationEstimation – Items in the model group will be physically reserved during estimation of the

production order.

SchedulingScheduling – Items in the model group will be physically reserved during scheduling of the

production order.

ReleaseRelease – Items in the model group will be physically reserved when the production order is released.

Star tStar t – Items in the model group will be physically reserved at the start of the production order.

A bulk lubricant material is produced in a 1,000-liter mixer. After the bulk material is ready, it's pumped out to

several filling stations, where bottles of different sizes are filled. After filling is completed, the bottles are packed

into boxes. Those boxes are then packed onto pallets.

In this scenario, a batch order to make 1,000 liters of bulk material is created. (This order is the bulk order.)

When this batch order is completed, it's reported as finished to the material input location of the filling stations.

A batch order to fill and pack each bottle size is then created. (These orders are the pack orders.) The pack orders

have a formula that consists of the bulk material, an empty bottle, a label, and other packing materials. Because

the bulk material flows directly from the mixer tank to the filling stations, no warehouse work is required to pick

this ingredient, and the bulk material is consumed directly from the input location. Therefore, the reservation

principle is set to manual. The other materials are staged to the filling station by pick work. Therefore, the

reservation principle for these lines is set to release, for example, so that the reservation automatically occurs

when the pack order is released.

Can you tell us about your documentation language preferences? Take a short survey.
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This topic describes, in detail, how the Phantom line type can be used for the lines of a bill of materials (BOM)

and a formula. In the following illustration, (a) is the BOM for product H and parts F and G, and (b) is the route

sheet for products H and part F.

This illustration shows an example of a BOM structure in two levels. Finished product H represents a product for

a machine assembly. The machine assembly consists of two parts, an electrical unit (F) that has two materials (A

and B) and a group of packaging materials (G) that also has two materials (C and D). Another material (E) is used

during the general assembly of the machine.

The preceding illustration represents the Engineering BOM for product H. This structure provides a good

overview of the parts and components of the overall machine assembly. However, although product designers

might prefer to see the BOM represented in this way, this structure might not correctly represent the way that

the machine is built on the shop floor.

For example, the Engineering BOM in the preceding illustration indicates that electrical unit F is assembled as a

separate part on a separate work order. However, on the shop floor, it might be judged more optimal to

assemble the electrical unit as part of the overall machine assembly, not as a separate work order.

This Engineering BOM also indicates that part G is a separate part. However, in this structure, part G doesn’t

represent a physical part but a collection of packaging materials.

Therefore, although an Engineering BOM provides great value for the design of a product and maintenance of

that design, it might not be the most logical way to support the manufacturing execution process of the product.

By contrast, a Manufacturing BOM represents the best way to build a product.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/phantom-items.md


Multilevel phantom BOM structures

The following illustration shows how the preceding Engineering BOM is transitioned into a Manufacturing BOM.

In this illustration, (a) is the BOM for product H, and b is the route sheet for product H.

In this structure, you can see that there is no notion of parts F and G, and the materials that these parts consist

of have been elevated to the next BOM level.

Unlike the Engineering BOM, which had two operations sheets, the Manufacturing BOM has only one operations

sheet. The packaging operation that was linked to part G has also been elevated and is now part of the

operations sheet for product H. The assembly of the electrical unit is the first operation. This order makes good

sense, because this unit is used in the next operation, which is the machine assembly. The last operation is the

packaging operation, which consumes two packing materials (C and D).

The transition between the Engineering BOM and the Manufacturing BOM is enabled through the Phantom

BOM line type. As the term “phantom” indicates, parts F and G have disappeared during the transition between

the two BOM types. In this example, the Phantom line type is applied to the BOM lines for parts F and G in the

Engineering BOM. When a production or batch order is created, the Engineering BOM is copied to the

production or batch order. Then, when the order is estimated, the transition from the Engineering BOM to the

Manufacturing BOM occurs, as shown in the preceding illustrations. From the operations sheet in the second

illustration, packaging materials C and D are input for the operation.

The Phantom line type can be used in multilevel BOM structures, as shown in the following illustration. In this

illustration, (a) is the BOM for product G, and (b) is the route sheet for parts E and F and product G.

The following illustration shows the resulting Manufacturing BOM and route sheet if the BOM lines for parts E

and F are configured so that the line type is Phantom. In this illustration, (a) is the BOM for product G, and (b) is

the route sheet for product G.



Phantom and route network
Phantom BOMs can also be used for a BOM that has a route network. In a route network, one or more

operations run in parallel. The following illustration shows an example of a route network that is used in a

multilevel BOM. In this illustration, (a) is the BOM for product G and part F, and (b) is the route sheet for product

G and part F, which has a route network.

In the following illustration, (a) is the BOM for product G and part F, and (b) is the route sheet for product G and

part F.
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The cost roll-up and sales price calculations are known as bill of materials (BOM) calculations, and you initiate

them from the Calculations page. This topic provides information about BOM calculations.

The cost roll-up and sales price calculations are known as bill of materials (BOM) calculations, and you initiate

them from the CalculationsCalculations  page. You use the CalculationsCalculations  page to perform the following tasks:

Calculate the cost of a manufactured item, and generate an associated item cost record within a costing

version.

Calculate the sales price of a manufactured item, and generate an associated item sales price record within a

costing version.

The way that you use the CalculationsCalculations  page varies slightly, depending on how you initiate the BOM

calculations. The way that you use the CalculationsCalculations  page also depends on whether the BOM calculations

involve a costing version for standard costs or planned costs, and on several policies that are defined in the

costing version that is used in the BOM calculations. Note:Note: A variation of the CalculationsCalculations  page is used in the

context of a sales order, sales quotation, or service order line item. These calculations are known as order-

specific BOM calculations. An order-specific BOM calculation doesn't generate an item cost record within a

costing version. Instead, it generates a calculation record that appears on the BOM calculation detailsBOM calculation details  page.

The calculation record includes a calculated cost and a calculated sales price. The CalculationsCalculations  page can be

opened for a single manufactured item or for a costing version:

To calculate costs for a single manufactured item, you initiate BOM calculations from the Item priceItem price page.

The CalculationsCalculations  page inherits the item identifier. The costing version, BOM version, route version,

calculation quantity, calculation date, and site must be specified.

To calculate costs for all manufactured items or selected items, or to update items on a where-used basis, you

initiate BOM calculations from the Costing version setupCosting version setup page or the Costing version maintenanceCosting version maintenance

page. The CalculationsCalculations  page inherits the costing version.

By default, the BOM version and route version are set to the active versions for the item, site, date, and

calculation quantity. However, you can override the default values with approved versions.

By default, the calculation quantity is set to the item's standard order quantity. However, you can

override the default value.

The calculation date or site can be mandated by the costing version, or user-specified values can be set

when the date or site isn't mandated in the costing version. A future calculation date determines how

pending cost records are used. BOM calculations use a pending cost record that has the nearest from-

date that is on or before the calculation date.

For the calculations, it's assumed that the active BOM version and route version are used for a

manufactured item (and for the related site, date, and quantity), unless a manufactured component

has a specified sub-BOM or subroute.

For the calculations, it's assumed that the standard order quantity is used for manufactured items. The

standard order quantity provides the basis for calculating component quantities, determining the

relevant BOM versions and route versions (when you use quantity-sensitive BOMs and routes), and

amortizing constant costs. However, when a manufactured component has a BOM line type of

ProductionProduction or VendorVendor , or when you use a make-to-order explosion mode for the BOM calculations,

this assumption doesn't apply, because quantities reflect the specified calculation quantity.

The calculation date or site can be mandated by the costing version, or user-specified values can be set

when the date or site isn't mandated in the costing version.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/bom-calculations.md


BOM calculations that use standard costsBOM calculations that use standard costs

BOM calculations that use planned costsBOM calculations that use planned costs

Other variations in BOM calculations reflect the costing type and restrictions of the costing version:

BOM calculations that use standard costs must be restricted by costing version policies, because the

restrictions help guarantee that standard costing principles are used. Standard costing principles require the

enforcement of restrictions about the use of standard costs for purchased items, a single-level explosion

mode, and the inclusion of miscellaneous charges in unit costs.

BOM calculations that use planned costs don't have to follow standard costing principles. These BOM

calculations can use different explosion modes, alternative sources of cost data for purchased items, and

optional enforcement of restrictions within the costing version.

Policies within the costing version (for standard costs) can mandate enforcement of five BOM calculation

policies. The Recording restr ictionRecording restr iction option in the costing version mandates one of these policies, where

miscellaneous charges must be included in the unit price. Miscellaneous charges for purchased items can be

entered manually, whereas miscellaneous charges for manufactured items reflect the calculated amortization of

constant costs. The Calculation restr ictionCalculation restr iction option in the costing version mandates the other four BOM

calculation policies:

The source of cost contributions for purchased items must be based on standard costs. In other words, BOM

calculations must use the item cost records within the specified costing version, or within the fallback that

contains standard costs.

To help guarantee accurate and consistent calculation of standard costs, the explosion mode must be single-

level.

To help guarantee consistent results when the sales price of the items is calculated, the profit setting must be

mandated. The profit setting can be used, and the item sales price records can be generated, only if the

costing version allows for content of sales prices.

The fallback principle must be mandated, and can be set to NoneNone, ActiveActive (for active cost records), or

Costing versionCosting version (for a specified costing version).

Policies within the costing version (for planned costs) can optionally mandate enforcement of five BOM

calculation policies. Alternatively, the policies can just provide default values. The Recording restr ictionRecording restr iction option

in the costing version determines whether the BOM calculation policy about miscellaneous charges will be

mandated or act as a default value. Miscellaneous charges can optionally be included in the unit price. The

Calculation restr ictionCalculation restr iction option in the costing version determines whether the other four BOM calculation

policies will be mandated or act as default values:

The source of cost contributions for a purchased item can be the item cost records within a costing version.

Alternatively, the source can be defined by the BOM calculation group that is assigned to the item. For

example, the BOM calculation group can define purchase price trade agreements as the source of cost

contribution data.

The explosion mode can be single-level, multilevel, or make-to-order, or it can be based on the BOM line

item. The explosion mode for the BOM line type replicates the cost calculation logic for production order

estimates.

The profit setting can be mandated, or it can be a default value. The profit setting can be used, and the item

sales price records can be generated, only if the costing version allows for content of sales prices.

The fallback principle can be mandated, or it can be a default value. The fallback principle can be set to NoneNone,

ActiveActive (for active cost records), or Costing versionCosting version (for a specified costing version).

BOM calculations generate warning messages and other types of messages. Several BOM calculation policies

determine the types of messages. The warning conditions are defined in the BOM calculation group that is

assigned to items. However, you can override these warning conditions when you initiate a BOM calculation.

When the fallback principle is used, it's often helpful if the fallback is shown as an information message. When



BOM calculations that use the fallback principle

BOM calculation of a suggested sales price

Order-specific BOM calculations

you're trying to update calculated costs for items that have missing cost records, it's also helpful if the

information message identifies items that weren't updated.

The following situations illustrate two uses of the fallback principle:

Two-version approach to standard cost updatesTwo-version approach to standard cost updates  - A costing version can contain the incremental

changes to standard costs, such as pending cost records that represent new items or cost changes. In this

situation, the fallback principle can identify the use of the active standard costs that are contained in other

costing versions.

S imulation of the effect of cost changes by using planned costsS imulation of the effect of cost changes by using planned costs  - A costing version for planned costs

can contain incremental changes for simulation purposes. This costing version will include pending cost

records that represent the simulated cost changes to items, cost categories, and calculation formulas for

indirect cost. In this situation, the fallback principle can identify the use of the active standard costs that are

contained in other costing versions.

When you use a cost-plus-markup approach, the calculated sales price for an item reflects the set of profit-

setting percentages that is specified for the BOM calculation, and the costs that are associated with the item's

component items, routing operations, and applicable manufacturing overheads. The markup reflects profit-

setting percentages that are assigned to cost groups, and the cost groups that are assigned to items, cost

categories for routing operations, and the indirect cost calculation formulas for manufacturing overheads. The

sets of profit-setting percentages are labeled StandardStandard, Profit 1Profit 1 , Profit 2Profit 2 , and Profit 3Profit 3 . Within the Profit 1 set,

for example, a profit-setting percentage of 50 percent can be defined for a cost group that is assigned to

purchased material, and a profit-setting percentage of 80 percent can be defined for a cost group that is

assigned to cost categories for routing operations. The context of the BOM calculation determines how the

results of a calculated sales price are handled:

BOM calculation for an item and specified costing versionBOM calculation for an item and specified costing version - The BOM calculation generates a

pending sales price record within the costing version. This sales price record provides the starting point for

viewing the calculation details (for example, on the Calculate item costCalculate item cost page). The sales price record acts

mainly as reference information and isn't used as the basis for a sales price on sales orders.

Order-specific BOM calculationOrder-specific BOM calculation - A variation of the BOM calculatioBOM calculation page is used in the context of a

sales order, sales quotation, or service order line item. An order-specific BOM calculation doesn't generate a

record in the within a costing version. Instead, it generates a calculation record that appears on the BOMBOM

calculation resultscalculation results  page. This calculation record provides the starting point for viewing the calculation

details (for example, on the Calculate item costCalculate item cost page). Information about a selected calculation record can

be transferred to the originating line item. For example, the calculated sales price can be transferred to a

sales order line item.

An order-specific BOM calculation represents a variation of a BOM calculation for a manufactured item. The

order-specific BOM calculation is performed in the context of a sales order, sales quotation, or service order line

item. An order-specific BOM calculation generates a calculation record that appears on the BOM calculationBOM calculation

resultsresults  page. The calculation record includes a calculated weight, a calculated cost that is based on active cost

records, and a calculated sales price. The calculation record that each order-specific BOM calculation for an item

generates on the BOM calculation resultsBOM calculation results  page is uniquely identified by a calculation number. The results of a

calculation record can be optionally transferred to the originating line item. An order-specific BOM calculation

differs from a BOM calculation for a manufactured item in two ways:

An order-specific BOM calculation doesn't generate an item cost record within a costing version. Therefore,



NOTENOTE

the BOM calculation policies aren't applied when an item cost record is created, or when a cost record is

overwritten.

An order-specific BOM calculation always uses the active cost records for components, cost categories, and

indirect cost calculation formulas.
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Create a unit of measure

Define unit translations

Define unit conversion rules

This procedure shows how to define a unit of measure, provide translations for the unit and it's description, and

define conversion rules for related units. You can walk through this procedure using demo data, or using your

own data.

1. Go to Navigation pane > Modules > Product information management > Released productNavigation pane > Modules > Product information management > Released product

maintenancemaintenance.

2. Click UnitsUnits .

1. Click NewNew .

2. In the UnitUnit field, type a value. Enter the ID or symbol to use when referring to the unit of measure.

3. In the Descr iptionDescr iption field, type a value. Enter a descriptive name for the unit of measure in the system

language.

4. In the Unit classUnit class  field, select an option. The unit class defines what logical grouping, such as area, mass, or

quantity, the unit of measure is part of.

5. In the Decimal precisionDecimal precision field, enter a number. Specify the number of decimals that the converted unit of

measure must be rounded to when a calculation is completed for the unit of measure.

6. Click SaveSave.

1. On the Action PaneAction Pane, click Unit textsUnit texts .

2. Click NewNew . Use unit text to create a translation of the ID or a symbol representing the unit of measure for use

on external documents in customer- or vendor-specific languages.

3. In the LanguageLanguage field, enter or select a value.

4. In the TextText field, type a value.

5. Click SaveSave.

6. Close the page.

7. On the Action PaneAction Pane, click Translated unit descr iptionsTranslated unit descr iptions .

8. Click NewNew . Define language-specific descriptions for the unit of measure.

9. In the LanguageLanguage field, enter or select a value.

10. In the Descr iptionDescr iption field, type a value.

11. Click SaveSave.

12. Close the page.

1. On the Action PaneAction Pane, click Unit conversionsUnit conversions . Define rules for converting the unit of measure to and from

other units of measure in the selected unit class.

2. Click NewNew  to open the drop dialog.

3. In the FactorFactor  field, enter a number. Conversion factor between the From unit and the To unit. For example,

the conversion factor from centimeter to meter is 100 because there are 100 centimeters in one meter.

4. In the To unitTo unit field, enter or select a value.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/pim/tasks/manage-unit-measure.md
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5. In the RoundingRounding field, select an option. Define how the converted value should be rounded.

6. Click OKOK.

7. Close the page.
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Types of production jobs

IMPORTANTIMPORTANT

This topic provides information about the setup of production parameters in Manufacturing execution.

The Manufactur ing executionManufactur ing execution module is intended primarily for manufacturing companies. It can be used to

register time and item consumption on production jobs or projects. Before you start to use Manufacturing

execution for job registrations, you must set up various production parameters that define how and when

registrations are posted during the production process. The settings of production parameters affect inventory

management, production management, and cost calculation.

Before workers start to make registrations on production jobs, you should carefully consider all settings on the

Production parametersProduction parameters  page. Click Production controlProduction control  > SetupSetup > Manufactur ing executionManufactur ing execution >

Production order defaultsProduction order defaults . If your company uses the multisite functionality, you might want to set up

different production parameters for each site. The parameters for integration with the ProductionProduction module are

set up on the following tabs on the Production parametersProduction parameters  page:

GeneralGeneral  – General parameter settings for production jobs in Manufacturing execution.

Star tStar t – Parameters that are used when production operations are started.

OperationsOperations  – Parameters that are applied to production operations and feedback about operations during

the production process.

Repor t as finishedRepor t as finished – Parameters that are used when items are reported as finished on the last operation of

a production order.

Quantity validationQuantity validation – Parameters that are used to validate start and feedback quantities on production

orders.

On the OperationsOperations  tab, you select which types of production jobs require registration on the Job registrationJob registration

page.

Typically, workers make registrations on setup jobs and process jobs. However, if job scheduling is applied, you

can select other job types that workers must make registrations on when production orders are processed. For

example, you can require registrations on transport jobs.

Make sure that you select all relevant job types. Otherwise, jobs might not be available for registration on the JobJob

registrationregistration page. Your selections should match the selections in the Job managementJob management  column on the SetupSetup tab of

the Route groupsRoute groups page (Production controlProduction control > SetupSetup > RoutesRoutes > Route groupsRoute groups).

If Job managementJob management is selected on the route group, this job type is reported as finished on the production

order when the job is reported as finished in Manufacturing execution. When all job types that JobJob

managementmanagement is selected for have been reported as finished on an operation, Manufacturing execution reports

the operation as finished.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/production-parameters-manufacturing-execution.md
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BOM consumption and picking list journals

Some job types can be manually reported through production journals. In this case, select Job managementJob management  for the job

type, but don't select the job type for registration on the OperationsOperations tab on the Production parametersProduction parameters  page in

Manufacturing execution.

A consistent setup for bill of materials (BOM) consumption is important, because it helps guarantee that

inventory management is efficient. For example, if BOM consumption parameters aren't set up correctly in

Manufacturing execution, materials might be deducted from inventory two times or not at all.

On the Production parametersProduction parameters  page, automatic BOM consumption is set up in three stages:

At the start of a production. Set up this stage on the Star tStar t tab.

During the production process when an operation is completed. Set up this stage on the OperationsOperations  tab.

When a production order is reported as finished. Set up this stage on the Repor t as finishedRepor t as finished tab.

For each stage, the Automatic BOM consumptionAutomatic BOM consumption field lets you select one of three methods for picking items

for a production order :

Flushing pr incipleFlushing pr inciple – This option is used in combination with an option that is defined for the BOM in

the ProductionProduction module. Click Production controlProduction control  > CommonCommon > Production ordersProduction orders  > AllAll

production ordersproduction orders . On the All production ordersAll production orders  page, select a production order in the list, and then,

on the Action Pane, click BOMBOM. On the BOMBOM page, on the SetupSetup tab, in Flushing pr incipleFlushing pr inciple field, select

one of the following options:

NOTENOTE

Star tStar t

FinishFinish

ManualManual

Blank (No option is selected.)

Available at locationAvailable at location

In Manufacturing execution, if Flushing pr incipleFlushing pr inciple is selected in the Automatic BOMAutomatic BOM

consumptionconsumption field on the Star tStar t tab, all materials that are set to Star tStar t in the BOM are deducted

from inventory when the operation is started. The Available at locationAvailable at location option is used for

products that are enabled for advanced warehouse processes. If you select this flushing principle,

material is flushed when warehouse work for raw material picking is completed. Material is also

flushed when a BOM line that uses this flushing principle is released to warehouse and the

material is available at the production input location.

If the Flushing principleFlushing principle field is set on the Star tStar t  tab in Manufacturing execution, you must select the

same principle on either the OperationsOperations tab or the Repor t as finishedRepor t as finished tab. This requirement helps

guarantee that materials are deducted from inventory on BOMs that use FinishFinish as a flushing principle on

the production order. If the same flushing principle isn't selected on either the OperationsOperations tab or the

Repor t as finishedRepor t as finished tab, materials might be deducted from inventory two times.

AlwaysAlways  – If you select this option for a stage, materials are always deducted from inventory at that stage.

For example, materials for the production are deducted when the production order is started. This setting

requires that NeverNever  be selected on the OperationsOperations  and Repor t as finishedRepor t as finished tabs. This requirement



IMPORTANTIMPORTANT

Example 1: Backflushing on operationsExample 1: Backflushing on operations

TA BTA B F IEL DF IEL D SET T IN GSET T IN G

Start Update start on-line StatusStatus or Status + quantityStatus + quantity

Start Automatic BOM consumption NeverNever

Operations Automatic BOM consumption AlwaysAlways

Report as finished Automatic BOM consumption NeverNever

Report as finished Update finished report on-line Status + quantityStatus + quantity

Example 2: Backflushing on productionExample 2: Backflushing on production

TA BTA B F IEL DF IEL D SET T IN GSET T IN G

Start Update start on-line StatusStatus or Status + quantityStatus + quantity

Start Automatic BOM consumption NeverNever

Operations Automatic BOM consumption NeverNever

Report as finished Automatic BOM consumption AlwaysAlways

Report as finished Update finished report on-line Status + quantityStatus + quantity

Example 3: Flushing principleExample 3: Flushing principle

helps prevent items from being deducted from inventory two times.

NeverNever  – If you select this option for a stage, no BOM consumption occurs at that stage. For example, if

you select NeverNever  on all three tabs (Star tStar t, OperationsOperations , and Repor t as finishedRepor t as finished), materials must be

manually deducted from inventory.

Carefully consider your setup of the production parameters, and make sure that the parameters that are selected on the

various tabs of the Production parametersProduction parameters  page don't contradict each other.

The following examples illustrate parameter settings that support various BOM consumption principles. The

parameters are set up on the Production parametersProduction parameters  page in Manufacturing execution.

Use the following settings if picking list journals and BOM item consumption should be generated when items

are reported as finished on an operation.

Use the following settings if picking list journals and BOM item consumption should be generated when items

are reported as finished on the production order.

Use the following settings if picking list journals and BOM item consumption should be generated according to

the flushing principle that is set for the BOM items.



TA BTA B F IEL DF IEL D SET T IN GSET T IN G

Start Update start on-line Status + quantityStatus + quantity

Start Automatic BOM consumption Flushing principleFlushing principle

Operations Automatic BOM consumption Flushing principleFlushing principle

Report as finished Automatic BOM consumption NeverNever

Report as finished Update finished report on-line Status + quantityStatus + quantity

Example 4: Deduction of materials during startup of a production orderExample 4: Deduction of materials during startup of a production order

TA BTA B F IEL DF IEL D SET T IN GSET T IN G

Start Update start on-line Status + quantityStatus + quantity

Start Automatic BOM consumption AlwaysAlways

Operations Automatic BOM consumption NeverNever

Report as finished Automatic BOM consumption NeverNever

Report as finished Update finished report on-line StatusStatus or Status + quantityStatus + quantity

Example 5: Manual BOM consumptionExample 5: Manual BOM consumption

TA BTA B F IEL DF IEL D SET T IN GSET T IN G

Start Update start on-line StatusStatus

Start Automatic BOM consumption NeverNever

Operations Automatic BOM consumption NeverNever

Report as finished Automatic BOM consumption NeverNever

Report as finished Update finished report on-line StatusStatus

Use the following settings if picking list journals and BOM item consumption should be generated when a

production is started.

Based on the selections that are described earlier in this section, picking list journals are posted at various stages

of the production order process:

When an operation is started

When quantity feedback is reported on an operation

When items are reported as finished on the production order

You can use the following settings if materials should always be manually deducted from inventory. In this case,

picking list journals aren't posted.
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Operations resources

Calendars

Resource capabilities

Operations resources perform the activities of a project or a production process. They can be of different types,

and can have different capabilities.

Operations resources are the machines, tools, workers, facilities, physical areas or vendors that perform the

activities of a project or a production process. They can be of different types and can have different capabilities.

VendorVendor  – An external resource that performs project activities or production operations. An example is a

subcontractor. By linking vendor resources to a vendor account, you can generate purchases for

subcontractors, based on the bill of materials (BOM) lines or production lines.

Human resourcesHuman resources  – A project or production worker that perform an activity, either alone or as an operator

of a tool or a machine. If you're using the Human resources functionality, you can link human resources to a

worker. The scheduling engine can then allocate the resources, based on the competencies that are defined

for the corresponding worker.

MachineMachine – A machine or other production equipment that is required in production.

ToolTool  – An instrument or device that is typically used together with another resource to perform an activity in

a project or in production.

LocationLocation – A physical location of a specific size that is required in order to perform an activity. An example is

an assembly area.

FacilityFacility  – A building or fixed structure that is required in order to perform an activity.

A calendar can be assigned to an operations resource and describes the capacity (in hours) of that resource. The

working times of the operations resource are determined by the calendar that is assigned to the resource group

that the operations resource is part of. You can set an effective date and an expiration date for the assigned

calendar. You can then assign more than one calendar to an operations resource. However, the dates of the

assigned calendars can't overlap, and the operations resource can be assigned only one calendar at a time.

Note:Note: If there are no effective working calendars for a resource group (for example, if the last assigned calendar

or the only assigned calendar has expired), you can no longer access the operations resources that are assigned

to the resource group for production planning and operations scheduling. You can also assign a calendar to a

resource group to specify the working times for both the resource group and all the operations resources that

are assigned to the resource group. The capacity of the resource group is calculated as the sum of the capacities

of each operations resource that is assigned to that resource group. The calendar that is assigned to a resource

group can change over time.

A capability is the ability of an operations resource to perform a particular activity. You can assign one or more

capabilities to an operations resource. The scheduling engine will then allocate resources by matching the

resource requirements of each activity to the capabilities of the available operations resources. Capabilities can

be assigned to all types of operations resources (ToolTool , VendorVendor , MachineMachine, Human resourcesHuman resources , LocationLocation, or

FacilityFacility ). To assign capabilities to operations resources for a limited time, define a start date and an expiration

date on the capability assignment. For more information, see Resource capabilities.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/operations-resources.md
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A resource group is a set of operations resources that represents the granularity at which you want to schedule

resources when you use the operations scheduling method. Therefore, resource groups typically correspond to

the physical organization of work cells that is demarcated by yellow lines on the production shop floor. The

resource group defines the site, production unit, and warehouse context for operations resources that are

assigned to the group. When you assign an operations resource to a resource group, the resource can be

scheduled at the site where the resource group is located. You don't have to assign the operations resources that

you create to a resource group. However, an operations resource must be assigned to a resource group before it

can be scheduled to perform work. An operations resource can be assigned to a resource group for a limited

time. You can also assign an operations resource to multiple resource groups, so that you can then share the

resource across sites. However, the effective dates and expiration dates can't overlap. In other words, you can't

assign an operations resource to two resource groups at the same time. Changes in resource group

assignments are effective only for new resource allocations. Capacity reservations for jobs, operations, and

project hour forecasts that are already scheduled won't be affected. Note:Note: When you assign operations

resources of the VendorVendor  type to a resource group, all operations resources that are assigned to that resource

group must be of the VendorVendor  type and must be linked to the same vendor account.

A production unit is an administrative unit that is a collection of resource groups. A production unit can contain

multiple resource groups, but a resource group can be assigned to only one production unit. A production unit

reflects the physical layout of production resources, and has no effect on transactions or how they are

processed. You must associate a production unit with a site. You can also assign a picking warehouse and a

storage warehouse to a production unit. You can use a production unit to consolidate and filter production-

related data. For example, a shop floor manager can see an overview of the outstanding workload and the

available capacity for a particular production unit. You can change the production unit that is assigned to a

resource group. You can also delete a production unit. However, these changes to the production unit are

effective only for new orders that are created after master scheduling is run. If you want to apply the production

unit change to existing orders, you must make this change manually.

Operations resources are assigned to activities when a project or a production is scheduled. Two scheduling

methods are available: operations scheduling and job scheduling. When you use operations scheduling, each

operation or project activity is scheduled on the resource group that contains operations resources that match

the resource requirements that are specified for the operation. If a specific operations resource is required for

the operation, scheduling reserves capacity only on a specific operations resource in the group. Job scheduling

is a more detailed form of scheduling than operations scheduling. It breaks down each operation into its

individual tasks or jobs. These jobs are then assigned to the operations resources that will perform them.

Scheduling reserves capacity on the resource groups, based on the operation times that are defined on the

production route or project activities. If you're working with finite capacity, the schedule depends on the

availability of the operations resources that are required in order to complete the activity. For operations

scheduling, the capacity of the resource group is the sum of the available capacity of the operations resources

that are part of that group. Capacity reservations that already exist for the operations resources are considered

unavailable capacity. If there isn't enough available capacity for production, the production orders can be

delayed or even stopped. On the ResourcesResources  page, you can define several properties that control how capacity

reservations are made:

CapacityCapacity  – Specify the operations resource's capacity per hour in terms of the capacity unit of measure.

Batch capacityBatch capacity  – Specify the maximum number of pieces that the operations resource can process per run.

Efficiency percentageEfficiency percentage – Specify the efficiency that you expect from the operations resource. The efficiency

percentage adjusts the throughput of the operations resource and affects the time that is reserved for the



Lean work cells

Costing resources

resource. The lead times for the operations that use the operations resource are also adjusted accordingly.

Here is the formula that is used for the calculation: Scheduling time = Time × 100 ÷ Efficiency percentage.

Time includes both the run time and setup time.

Operations scheduling percentageOperations scheduling percentage – Specify the maximum percentage of capacity of the operations

resource that you want to use in operations scheduling. To allow for flexibility in capacity during job

scheduling, you should set this percentage to less than 100 percent.

Finite capacityFinite capacity  – Set this option to YesYes  if the operations resource should be scheduled based on the actual

capacity that is available, and if existing capacity reservations should be considered. If this option is set to NoNo,

the operations resource is assumed to have infinite capacity, and the resource might therefore be

overbooked.

Finite proper tyFinite proper ty  – Set this option to YesYes  if you want the operations resource to be scheduled based on the

actual capacity that is available with respect to the required working time scheduling properties.

ExclusiveExclusive – Set this option to YesYes  if you don't want the operations resource to be available for another job or

operation until the current production is completed. In this case, the operations resource can't be used even if

there are gaps in the resource's run time.

Bottleneck resourceBottleneck resource – Define the operations resource as a bottleneck resource. A bottleneck resource is

scheduled by using finite capacity when the Finite capacityFinite capacity  and Bottleneck schedulingBottleneck scheduling options on the

Master plansMaster plans  page are selected.

To schedule multiple operations resources at the same time to perform, for example, an operation in production,

you must specify the requirements for the various resources by using primary and secondary operations. You

can then also reserve multiple operations resources that have different capacity. The operations resource that

are scheduled for the primary operation determine the duration of the activity.

You can specify that a resource group is a lean work cell. The resource group can then be part of a production

flow. By specifying a resource group as a lean work cell, you also prevent the resource group and the assigned

operations resources from being allocated to the operations of a production order or a project hour forecast. For

each resource group that acts as a lean work cell, you must specify the following information:

CalendarCalendar  – The working calendar of the work cell, which must have the property of a standard workday.

Input warehouse and locationInput warehouse and location – The default location that is used to pick material for an activity.

Output warehouse and locationOutput warehouse and location – The default location where all output of the work cell is put.

Runtime cost categor yRuntime cost categor y  – This category must be defined for the work cell if direct labor is tracked in

costing.

When a resource group is used as a lean work cell, the capacity of the work cell is specified directly on the

resource group. Therefore, you don't have to assign operations resources to the resource group. Only when the

work cell is managed by a subcontractor, an operations resource of the VendorVendor  type must be assigned to the

work cell. If you assign an operations resource to a resource group that is marked as a work cell, the capacity of

the work cell isn't affected.

When you define an activity such as a route operation or a project hour forecast, you can specify the

requirement for a specific operations resource or resource group. However, you can also specify the

requirement for an operations resource of a specific type, or an operations resource that has a specific capability

or competency. For this reason, the actual resource assignment isn't made until the activity is scheduled and

capacity is reserved. Therefore, on a route operation, you can specify that estimation and BOM calculation must

be based on a specific operations resource. This operations resource is referred to as the costing resource. You

can also transfer cost categories and operation times from the costing resource to the activity. When the

operation is scheduled, estimation and BOM calculation are done by using the operations resource that is
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Define capacity and consumption parameters

Define working times

An operations resource performs the activities of a project or a production process. This procedures shows you

how to define an operations resource. You can walk through this procedure in demo data company USMF, or

using your own data.

1. Go to Resources.

2. Click New.

3. In the Resource field, type a value.

4. In the Description field, type a value.

1. Expand the Operation section.

2. In the Scrap percentage field, enter a number.

3. In the Setup category field, enter or select a value.

4. In the Run time category field, enter or select a value.

5. In the Quantity category field, enter or select a value.

6. In the Capacity unit field, select an option.

7. In the Capacity field, enter a number.

8. In the Efficiency percentage field, enter a number.

9. In the Operations scheduling percentage field, enter a number.

10. Select Yes in the Finite capacity field.

11. Select Yes in the Bottleneck resource field.

Specify the cost category that defines how to account for the cost of setup.

Specify the cost category that defines how to account for the cost of run time.

Specify the cost category that defines how to account for the resource cost based on the output

quantity.

Specify the unit in which to express the capacity of the operations resource.

Specify the efficiency that you expect from the operations resource. The efficiency percentage adjusts

the throughput of the operations resource and affects the time that is reserved for the resource.

Specify the maximum percentage of capacity of the operations resource that you want to use in

operations scheduling.

Set this option to Yes if the operations resource should be scheduled based on the actual capacity that

is available, and if existing capacity reservations should be considered. If this option is set to No, the

operations resource is assumed to have infinite capacity, and the resource might be overbooked.

1. Expand the Calendars section.

2. Click Add.

3. In the Calendar field, enter or select a value.

4. In the list, find and select the desired record.

5. In the list, click the link in the selected row.

Specify the working time calendar that defines the capacity (in hours) of the resource.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/create-operations-resource.md
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1. Expand the Capabilities section.

2. Click Add.

3. In the Capability field, enter or select a value.

4. In the Level field, enter a number.

5. In the Priority field, enter a number.

A capability is the ability of an operations resource to perform a particular activity. The scheduling

engine allocates resources by matching the resource requirements of each activity to the capabilities

of the available operations resources.

Specify the level of proficiency by which the resource processes the capability.

Specify the priority of the operations resource with respect to the capability. When scheduling by

priority, the operations resource with the highest priority (lowest numeric value) is selected first.

1. Expand the Resource groups section.

2. Click Add.

3. In the Resource group field, enter or select a value.

4. In the Input location field, enter or select a value.

The resource group defines the site, production unit, and warehouse context for operations resources.

The operations resource can only be scheduled when assigned to a resource group, and only on the

site where the resource group is located.

Specify the warehouse location from where the operations resource is consuming materials.
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Level

Priority

Resource requirements

This article provides information about resource capabilities. A capability is the ability of an operations resource

to perform a particular activity. The article explains how capabilities and related concepts, such as proficiency

level and priority, are used to select appropriate resources for an activity.

A capability is the ability of an operations resource to perform a particular activity. An operations resource can

have more than one capability assigned to it, and a capability can be assigned to more than one resource. You

can temporarily assign capabilities to resources by defining a start date and expiration date on the capability

assignment. When the capability for a resource expires, the resource can't be scheduled for a project or a

production that requires that capability. A capability that has expired can be renewed. You can delete capabilities,

provided that they aren't on a route relation or on part of a production route of an active production order. In

general, be careful when you delete capabilities. Instead, consider adjusting the expiration date on the resources

that have the capability. Capabilities can be assigned to all types of resources: tool, vendor, machine, location,

facility, or human resource.

Multiple resources often have the same functional capability but at different levels of proficiency (for example,

strength, processing speed, or accuracy). Therefore, when you assign a capability to a resource, you can specify a

LevelLevel  value. The level is a simple numeric value. If you specify that a capability is a resource requirement for a

production route, you can also specify a Minimum level neededMinimum level needed value for that capability. The scheduling

engine then selects only resources that have the required capability at a level that is equal to or exceeds the

minimum level that is specified in the resource requirement.

Operations resources that have the same capabilities can be assigned a priority. Then, if multiple resources have

capabilities that satisfy the scheduling requirements at the required level, and have free capacity, the scheduling

engine can select among those resources. If Pr ior ityPr ior ity  is selected in the Pr imar y resource selectionPrimar y resource selection field on

the Scheduling parametersScheduling parameters  page, the resource that has the highest priority (the lowest numeric value in the

Prior ityPr ior ity  field) is selected first during scheduling.

When you define resource requirements for a production route, you can specify one or more capabilities as

requirements. During production scheduling, the capabilities that are defined in the resource requirements on

the route operation are matched with the capabilities that are defined for the resources. Resources that have

capabilities that satisfy the requirements are selected. If multiple resources have the same functional capability

but different proficiencies (such as strength, processing speed, or accuracy), you can either define multiple

capabilities or use the capability level to qualify the capability of the resource. Here is an example:

On a route, the drilling process time is set to 10 units per hour, but the requirement itself is defined as

Drilling.

You have two drilling machines, M1 and M2.

The Drilling capability is assigned to both resources, the M1 machine and the M2 machine.

The M1 machine can drill two units per hour, and the M2 machine can drill 11 units per hour.

In this example, both machines can be selected by the scheduling engine, because both satisfy the basic

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/resource-capabilities.md


Competencies for human resources

NOTENOTE

capability requirement (Drilling). However, the M1 machine can drill only two units per hour. Because this rate is

much less than the 10 units per hour that are specified on the route, the M1 machine will cause production

problems if it's selected. There are two ways to resolve this issue and make sure that the M2 machine is selected

instead:

Create two separate capabilities: Low-speed drilling and High speed drilling. Define Low-speed drilling as

drilling that has a process time of one to nine units per hour. Define High-speed drilling as drilling that has a

drilling process time of 10 to 19 units per hour. Then assign the M1 machine the Low-speed drilling

capability, and assign the M2 machine the High-speed drilling capability. Finally, change the resource

capability requirement on the route to High-speed drilling. The scheduling engine will then select the correct

machine (M2).

Use the capability level to qualify the Drilling capability that is assigned to the drilling machines. Specify that

the M1 machine has the Drilling capability at a level of 2.0, and that the M2 machine has the Drilling

capability at a level of 11.0. Then specify that 10.0 is the minimum level that is required for the Drilling

capability requirement on the route. The scheduling engine will then determine that only the M2 machine

satisfies the resource requirements.

When you have operations resources of the Human resourcesHuman resources  type that are linked to workers in Human

resources, you can also take advantage of the competencies of workers when you define the resource

requirements for a production route. In other words, you can also specify requirements for specific skills,

courses, certificates, or titles. The scheduling engine can then select resources that are linked to workers, and the

selection will be based on the competencies of those workers. The competencies are set up in Human resources,

not on the Resource capabilitiesResource capabilities  page. When you define skills, courses, certificates, or titles as resource

requirements, you must use the Human resources functionality and link each resource of the HumanHuman

resourcesresources  type to a corresponding worker. If you aren't using the Human resources functionality, you can

define capabilities on the Resource capabilitiesResource capabilities  page that resemble or duplicate the competencies from

Human resources. However, the Resource capabilitiesResource capabilities  page doesn't contain the functionality that is required

in order to maintain skills, courses, certifications, or titles.
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Create a resource capability

Assign capability to a resource
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Resource capabilities describe what operations resources can do. During scheduling, the requirements of each

job and operation are matched against the capabilities of the available resources. This task guide will help you

create a resource capability and assign it to a resource. The demo data company used to create this task is USMF.

1. Go to Resource capabilities.

2. Click New.

3. In the Capability field, type the ID of the resource capability.

4. In the Description field, enter a description of the capability.

For a given operation, you use the capability ID to specify that resources must have this capability to

perform the operation.

1. Click Add.

2. In the Resource field, type the ID of the resource.

3. In the Expiration field, enter a date.

4. In the Priority field, enter a number.

5. In the Level field, enter a number.

A resource capability can be assigned to one or more resources.

You can use this field to specify that a resource has the capability for only a limited time.

When you schedule jobs and operations, you can specify whether to select resources by priority. If you

choose to do this, and more than one resource can perform the job or operation by the requested

date, the resource that has the lowest priority with respect to the required capability is selected.

When you specify that a job or operation requires a particular capability, you can also specify the

minimum level that is required. Use the capability level to differentiate resources that can perform the

same job, but at different speeds, strengths, sizes, and so on.
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Overview

Routes

Simple routesSimple routes

This topic provides information about routes and operations. A route defines the process for producing a

product or product variant. It describes each step (operation) in the production process and the order that these

steps must be performed in. For each step, the route also defines the required operations resources, the

required setup time and run time, and how the cost should be calculated.

A route describes the order of operations that is required in order to produce a product or product variant. For

each operation, the route also defines the operations resources that are required, the time that is required in

order to set up and perform the operation, and how the cost should be calculated. You can use the same route to

produce multiple products, or you can define a unique route for each product or product variant. You can even

have multiple routes for the same product. In this case, the route that is used varies, depending on factors such

as the quantity that must be produced. The definition of a route in Supply Chain Management consists of four

separate elements that, together, describe the production process:

RouteRoute – A route defines the structure of the production process. In other words, it defines the order of

operations.

OperationOperation – An operation identifies a named step in a route, such as AssemblyAssembly . The same operation can

occur in multiple routes and can have different operation numbers.

Operation relationOperation relation – An operation relation defines the operational properties of an operation, such as the

setup time and run time, cost categories, consumption parameters, and resource requirements. The

operation relation enables the operational properties of an operation to vary, depending on the route that

the operation is used in or the products that are being produced.

Route versionRoute version – A route version defines the route that is used to produce a product or product variant.

Route versions enable routes to be reused across products or changed over time. They also enable different

routes to be used to produce the same product. In this case, the route that is used depends on factors such as

the location or the quantity that must be produced.

A route describes the order of operations that is used to produce a product or product variant. Each operation is

assigned an operation number and a successor operation. The order of operations forms a route network that

can be represented by a directed chart that has one or more starting points and a single end point. In Supply

Chain Management, routes are distinguished based on the type of structure. The two types of routes are simple

routes and route networks. In the Production control parameters, you can specify whether only simple routes

can be used, or whether the more complex route networks can be used.

A simple route is sequential, and there is only one starting point for the route.

If you enable only simple routes in the Production control parameters, Supply Chain Management automatically

generates the operation numbers (10, 20, 30, and so on) when you define the route.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/routes-operations.md
file:///T:/eiye/ac1a/dynamics365/supply-chain/production-control/media/routes-and-operations-1-simple-route.png
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Parallel operationsParallel operations

Approval of routesApproval of routes

If you enable the more complex route networks in the Production control parameters, you can define routes that

have multiple starting points and operations that can be run in parallel.

Each operation can have only one successor operation, and the entire route must end in a single operation.

This does not ensure that multiple operations that have the same successor operation (for example, operations 30 and

40 in the preceding illustration) will actually be run in parallel. The availability and capacity of resources might put

constraints on the way that operations are scheduled.

You can't use 0 (zero) as the operation number. That number is reserved and is used to specify that the last operation

in the route has no successor operation.

Sometimes, a combination of multiple operations resources that have different characteristics is required in

order to perform an operation. For example, an assembly operation might require a machine, a tool, and one

worker for every two machines to oversee the operation. This example can be modeled by using parallel

operations, where one operation is designated as the primary operation and the others are secondary.

Typically, the primary operation represents the bottleneck resource and dictates the run time for the secondary

operations. However, during scheduling that involves finite capacity, the resources that are scheduled for both

the primary operation and the secondary operations must be available and have free capacity at the same time.

Both the primary operation and the secondary operations must have the same operation number (30 in the

preceding illustration).

In the preceding example, the resource requirement for the primary operation (30) is the machine, whereas the

resource requirements for the secondary operations (30' and 30'') are the tool and the worker. A fifty-percent

load helps guarantee that the scheduled worker can oversee two machines at the same time.

A route must be approved before it can be used in the planning or manufacturing process. Approval indicates

that the route design has been completed. The same released product or released product variant can have

file:///T:/eiye/ac1a/dynamics365/supply-chain/production-control/media/routes-and-operations-2-route-network.png
file:///T:/eiye/ac1a/dynamics365/supply-chain/production-control/media/routes-and-operations-3-parallel-operations.png


   

Operations
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PipeCut Pipe cutting

TIGweld TIG welding

JigAssy Jig assembly

Inspection Quality inspection

Operation relations
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multiple approved routes. Typically, approval of a route occurs when the first relevant route version is approved.

However, in some business scenarios, the approval of the route and the route version are separate activities that

might involve different process owners.

Each route can be approved or unapproved separately. However, note that, when a route is unapproved, all

related route versions are also unapproved. In the Production control parameters, you can specify whether

routes can be unapproved, and whether approved routes can be changed.

If you must keep a log that records who approves each route, you can require electronic signatures for route

approval. Users will then have to confirm their identity by using an electronic signature.

An operation is a step in the production process. Each operation has an ID and a simple description. The

following tables shows typical examples of operations from a machine shop.

The operational properties of the operation, such as the setup time and run time, resource requirements, costing

information, and consumption calculation, are specified on the operation relation. (For more information about

operation relations, see the next section.)

The following operational properties of an operation are maintained on the operation relation:

Cost categories

Consumption parameters

Processing times

Processing quantities

Resource requirements

Notes and instructions

You can define multiple operation relations for the same operation. However, each operation relation is specific

to one operation, and stores properties that are specific to a route, a released product, or a set of released

products that are related to an item group. Therefore, the same operation can be used in multiple routes that

have different operational properties. In addition, you can more easily maintain your master data if you use

standard operations that have the same operational properties, regardless of the route that is used and product

that is produced. The scope of the operation relation is defined through the Item codeItem code, Item relationItem relation, RouteRoute

codecode and Route relationRoute relation properties, as shown in the following table.
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Table <Item ID> Route <Route ID> The operational
properties of an
operation when it's
used in the route
where RouteRoute
numbernumber=<route
ID> to produce the
released product
where ItemItem
numbernumber=<item ID>.

Table <Item ID> All The default
operational
properties of an
operation when it's
used to produce the
released product
where ItemItem
numbernumber=<item ID>.
In other words, these
operational
properties apply
when there is no
route-specific
operation relation for
the released product.

Group <Item group ID> Route <Route ID> The operational
properties of an
operation when it's
used in the route
where RouteRoute
numbernumber=<route
ID> to produce
released products
that are associated
with item group
<item group ID>,
unless there is a
route-specific
operation relation for
the released product.

Group <Item group ID> All The default
operational
properties of an
operation when it's
used to produce
released products
that are associated
with item group
<item group ID>,
unless a more specific
operation relation
exists.
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All Route <Route ID> The default
operational
properties of the
operation when it's
used in the route
where RouteRoute
numbernumber=<route
ID>. In other words,
these operational
properties apply
when there is no
operation relation for
this route that is
specific to either the
released product or
its associated item
group.

All All The default
operational
properties of an
operation. These
operational
properties apply
when a more specific
operation relation
doesn't exist.
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Modifying product-specific routesModifying product-specific routes

You can also specify that an operation relation is specific to a site. In this way, the operational properties of an

operation can vary, depending on the location (that is, the site) where the operation is performed. For

configured products, you can also specify different operational properties for each product configuration.

Operation relations give you lots of flexibility when you define your routes. Additionally, the ability to define

default properties helps reduce the amount of master data that you must maintain. However, this flexibility also

means that you must be aware of the context that you modify an operation relation in.

Because the operational properties are stored in operation relations per operation for each route, all occurrences of the

same operation (for example, Assembly) have the same setup time, run time, and resource requirements. Therefore, if two

occurrences of an operation must occur in the same route but have different run times, you must create two separate

operations, such as Assembly1 and Assembly2.

When you open the RouteRoute page from the Released product detailsReleased product details  page, the route versions that are

associated with the selected released product are shown. In this context, for each operation, Supply Chain

Management shows the operational properties from the operation relation that best matches the route version.

You will notice that the list of operations includes the Item codeItem code and Route codeRoute code properties from the

operation relation. Therefore, you can determine which operation relation is shown.

On the RouteRoute page, you can modify the operational properties of the operation, such as the run time or the cost

categories. Your changes are stored on the operation relation that is specific to the route and released product

that are referenced in the current route version. If the operation relation that is shown isn't specific to the route

and the released product, before your changes are stored, the system creates a copy of the operation relation.



NOTENOTE

Maintaining operation relations per routeMaintaining operation relations per route

Maintaining operation relations per operationMaintaining operation relations per operation

Applying operation relationsApplying operation relations

This copy is specific to the route and released product. Therefore, your changes won't affect other routes or

released products. To verify which operation relation is being modified on the RouteRoute page, look at the ItemItem

codecode and Route codeRoute code fields.

You can also manually create an operation that is specific to a route and released product by using the CopyCopy

and edit relationand edit relation function.

If you add a new operation to a route on the RouteRoute page, an operation relation is created only for the current released

product. Therefore, if the route is also used to produce other released products, no applicable operation relation will exist

for those released products, and the route can no longer be used for those released products.

When you open the Route detailsRoute details  page from the RoutesRoutes  list page, a list of all the operation relations that apply

to the selected route is shown. Therefore, you can easily verify which operational properties are used for which

products. You can modify both default property values and product-specific property values.

If you add a new operation relation on the Route detailsRoute details  page, the Route codeRoute code field is automatically set to

RouteRoute, and the Route relationRoute relation field is set to the route number of the current route.

From the OperationsOperations  page, you can open the Operation relationsOperation relations  page. On this page, you can modify all

operation relations for a specific operation. You can even modify operation relations that contain default values.

If your business uses standard operations, and if the operational parameters are the same across all products

and processes, the Operation relationsOperation relations  page provides a convenient way to maintain the default operational

properties of those operations.

In some cases, Supply Chain Management must find the operational properties for an operation. For example,

when a purchase order is created, the operational properties of each operation must be copied from the

operation relations to the production route. In these situations, Supply Chain Management searches the relevant

operation relations from the most specific combination to the least specific combination.

When Supply Chain Management searches for the most relevant operation relation for a released product, an

operation relation that matches the item ID of the released product is preferred over an operation relation that

matches the item group ID. In turn, an operation relation that matches the item group ID is preferred over the

default operation relation. The search is done in the following order :

1. Item codeItem code=TableTable and Item relationItem relation=<item ID>

2. Item codeItem code=GroupGroup and Item relationItem relation=<item group ID>

3. Item codeItem code=AllAll

4. Route codeRoute code=RouteRoute and Route relationRoute relation=<route ID>

5. Route codeRoute code=AllAll

6. ConfigurationConfiguration=<configuration ID>

7. ConfigurationConfiguration=

8. S iteSite=<site ID>

9. S iteSite=

Therefore, an operation should be used only one time for each route. If the operation occurs multiple times in

the same route, all occurrences of that operation will have the same operation relation, and you won't be able to

have different properties (for example, run times) for each occurrence.



 Route versions

Approval of route versionsApproval of route versions

Activating the default route versionActivating the default route version

Electronic signaturesElectronic signatures

Product change that uses case managementProduct change that uses case management

Maintaining routes

Making routes independent of resourcesMaking routes independent of resources

Route versions are used to accommodate variations in the production of products or provide greater control

over the production process. They define which route should be used when a specific released product or

released product variant is produced. You can use the following constraints to define which route is used for a

released product:

Product dimensions (size, color, style, or configuration)

Production quantity

Production site

Production date

When you're producing the product at a specific site, in a specific quantity, or in a specific period, you can

designate a specific route version as the default route version. However, note that only one active route is

allowed for a given released product and a given set of constraints.

In the Production control parameters, you can require that the validity period of a route version always be

specified.

Before a route version can be used in the planning or manufacturing process, it must be approved. When you

approve a route version, you can also approve the related route. However, note that a route version can be

approved only if the related route is also approved.

When you activate a route version, you designate it as the default route version that master planning will use, or

that will be used to create production orders. You can have only one active route version for a given set of

constraints (for example, period, site, or quantity). If the version that you’re trying to activate conflicts with a

version that is already active, you receive an error message. To prevent an ambiguous activation, you must then

either inactivate the conflicting version or modify the constraints (usually the period) on the route version.

If you must keep a log that records who approves and activates each route version, you can require electronic

signatures for these tasks. Users who approve and activate route versions will then have to confirm their identity

by using an electronic signature.

The product change case for the approval and activation of new or changed routes and route versions gives you

an easy way to see an overview of the route version constraints. You can also approve and activate all routes

that are related to a specific change in one operation and document the results in the product change case.

Depending on your business requirements, you might be able to reduce the effort that is required in order to

maintain your process definitions.

In many systems, the operations resource or resource group that should perform an operation must be

specified in the route. However, in Supply Chain Management, you can define a set of requirements that an

operations resource must meet to be applicable for the operation. Therefore, the specific operations resource or

resource group that should be used doesn't have to be determined until the operation is actually scheduled. This

functionality is especially useful when you have many workers or machines that can perform the same

operation.

For example, you specify that an operation requires an operations resource of the MachineMachine type that has a
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Sharing routes across sitesSharing routes across sites

Standard operation relationsStandard operation relations

Resource-specific process timesResource-specific process times

StampingStamping capability of 20 tons. The scheduling engine will then resolve these requirements to a specific

operations resource or resource group when the operation is scheduled. Because you can just specify these

requirements instead of binding the operation to a specific machine, you have much more flexibility.

Additionally, maintenance is easier when resources are moved or new resources are added.

For more information about the various types of resource requirements and how to use them, see Operations

resource requirements and Resource capabilities.

If you produce the same product at more than one production site, and if the steps for producing the product

are the same at all sites, you can often design a shared route that is used across all production sites. To create a

shared route, don't specify a site on the route itself. However, you must still create a route version that associates

the shared route with the product at each site.

You must also make sure that the resource requirements for each operation in the route don't call for specific

operations resources or resource groups, but are instead expressed in terms of the characteristics of the

required resources. The scheduling engine will then be able to assign the appropriate operations resources from

the site that the production is scheduled on. For example, if there are small differences in the run time, or if the

setup time for a certain operation is site-specific, you can specify this information by adding an additional

operation relation for that site.

To take full advantage of the benefits of shared routes, you should also use resource consumption on the

corresponding bill of materials (BOM). When you set the flag for resource consumption on the BOM line, the

warehouse and location that raw materials should be consumed from is inferred from the operations resource

that the operation is scheduled on. Therefore, the warehouse and location don't have to be determined until the

production is actually scheduled. In this way, you can make both the BOM and the route independent of the

physical location where the product is produced.

If your business uses standardized operations throughout production, and if there is little or no variation in the

setup time, run time, consumption calculation, cost calculation, and so on, you might benefit from creating

default operation relations for all operations. In this case, avoid creating operation relations that are specific to

any route or released product.

If you also express resource requirements in terms of skills and capabilities, and make your routes site-

independent, you can help keep the ongoing maintenance of your business processes to a minimum.

When you use this approach, the Operation relationsOperation relations  page becomes your primary destination for maintaining

run times and other properties.

If you don't specify an operations resource or resource group as part of the resource requirements for an

operation, the applicable resources might operate at different speeds. Therefore, the time that is required in

order to process an operation might vary. To resolve this issue, you can use the FormulaFormula field on the operation

relation to specify how the process time is calculated. The following options are available:

StandardStandard – (Default option) The calculation uses only the fields from the operation relation and multiplies

the specified run time by the order quantity.

CapacityCapacity  – The calculation includes the CapacityCapacity  field from the operations resource. Therefore, the time is

resource-dependent. The value that is specified on the operations resource is capacity per hour. The ProcessProcess

timetime is calculated as Order quantityOrder quantity  divided by CapacityCapacity .

BatchBatch – A batch capacity is calculated by using information from the operation relation. The number of

batches and, therefore, the process time can then be calculated based on the order quantity.

Resource batchResource batch – This option is basically the same as the BatchBatch option. However, the calculation includes

the Batch capacityBatch capacity  field from the operations resource. Therefore, the time is resource dependent.



Set up route groupsSet up route groups

NOTENOTE

Additional resources

NOTENOTE

You can define the route groups and the setup for its route or job types under Production control > Setup >Production control > Setup >

Routes > Route groupsRoutes > Route groups . For each Route/job type in the route group, you can select or clear the following

options:

ActivationActivation - Select this option to enable calculations and scheduling for the selected job type, and to receive

job feedback when you run job scheduling. You need to select this option to enable the job type and then,

select the rest of the options for that job type. If the activation is not selected, that job type will not be

enabled, regardless of the selection of the other options.

Job managementJob management - Select this option to include the job type in job management when you run job

scheduling.

Working timeWorking time Select this option to schedule the job type according to the working time calendar that is

defined for the operations resource, otherwise the Gregorian calendar is used. Working time can be

scheduled either according to the Gregorian calendar or the defined working calendar. If you select this

option, scheduling is based on the defined working time calendar. Additionally, the job of the job type is

scheduled from midnight on the date that is defined as the job's starting date.

CapacityCapacity  - Select this option to reserve capacity for the job type when you run job scheduling. If you select

this option, capacity is reserved when scheduling is run for the selected job type. This gives you an overview

of which job types in each route group use the operations resources. For example, in a situation where

drying resources are bottleneck resources, these resources must be specified as bottlenecks. Drying

operations that are assigned to queue time job types will reserve drying resources.

For each of the job types, you first need to activate or de-activate it. When de-activated, none of the other setup

(Job management, working time, and capacity) will be considered, as the job type will not be active.

Among the job types you can find Overlap. Overlap allows different jobs to be performed at the same time.

When jobs are overlapping, the resources can be used but cannot be reserved for the specific jobs. Therefore,

when Activation is selected for Overlap, the rest of the settings (Job management, Working time, and Capacity)

do not make any impact in the route group.

When you upgrade versions, you might encounter the following error: "CRL Error occurred while invoking the"CRL Error occurred while invoking the

scheduling engine"scheduling engine". If you receive this error, go to the Route groupsRoute groups page and for all the routes where you have

activated OverlapOverlap, clear the Job managementJob management , Working timeWorking time, and CapacityCapacity  options.

Bills of materials and formulas

Cost categories used in production routing

Resource capabilities

Electronic signature overview
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NOTENOTE

Activate the features in your system

The Work policies page

The Work order types FastTabThe Work order types FastTab

W O RK O RDER T Y P EW O RK O RDER T Y P E W O RK P RO C ESSW O RK P RO C ESS

Raw material picking All related processes

Co-product and by-product put away All related processes

Finished goods putaway All related processes

Transfer receipt License plate receiving (and putaway)

This topic explains how to set up the system and the warehouse app so that they support work policies. You can

use this functionality to quickly register inventory without creating putaway work when you receive purchase or

transfer orders, or when you complete manufacturing processes. This topic provides general information. For

detailed information that is related to license plate receiving, see License plate receiving via the warehouse app.

A work policy controls whether warehouse work is created when a manufactured item is reported as finished, or

when goods are received by using the warehouse app. You set up each work policy by defining the conditions

where it applies: the work order types and processes, the inventory location, and (optionally) the products. For

example, a purchase order for product A0001 must be received in location RECV in warehouse 24. Later, the

product is consumed in another process at location RECV. In this case, you can set up a work policy to prevent

putaway work from being created when a worker reports product A0001 as received in location RECV.

For a work policy to be active, you must define at least one location for it on the Inventor y locationsInventor y locations FastTab of the

Work policiesWork policies  page.

You can't specify the same location for multiple work policies.

The Print labelPrint label option for mobile device menu items won't print a license plate label unless work was created.

To make all the functionality that is described in this topic available in your system, turn on the following two

features in Feature management:

License plate receiving enhancements

Work policy enhancements for inbound work

To set up work policies, go to Warehouse management > Setup > Work > Work policiesWarehouse management > Setup > Work > Work policies . Then, on each

FastTab, set the fields as described in the following subsections.

On the Work order typesWork order types  FastTab, add all the work order types, and the related work processes, that the work

policy applies to. The following work order types and related work processes are supported for work policies.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/warehouse-work-policies.md


Purchase orders

W O RK O RDER T Y P EW O RK O RDER T Y P E W O RK P RO C ESSW O RK P RO C ESS

The Inventory locations FastTabThe Inventory locations FastTab

The Products FastTabThe Products FastTab

Default and custom "to" locations

NOTENOTE

License plate receiving (and putaway)

Load item receiving (and putaway)

Purchase order line receiving (and putaway)

Purchase order item receiving (and putaway)

To set up a work policy so that it applies to several work processes of the same work order type, add a separate

line for each work process to the grid.

For each line in the grid, set the Work creation methodWork creation method field to one of the following values:

NeverNever  – The work policy will prevent warehouse work from being created for the selected work order type

and related work process.

Cross dockingCross docking – The work policy will create cross-docking work by using the policy that you select in the

Cross docking policy nameCross docking policy name field.

On the Inventor y locationsInventor y locations  FastTab, add all the locations where this work policy should be applied. If no

location is associated with a work policy, the work policy won't be applied to any process.

You can't specify the same location for multiple work policies.

You can use a warehouse location that is assigned to a location profile where the Use license plate trackingUse license plate tracking

option is turned off. In this case, workers will directly register the on-hand inventory.

On the ProductsProducts  tab, set the Product selectionProduct selection field to control which products the policy should apply to:

AllAll  – The policy should apply to all products.

SelectedSelected – The policy should apply only to products that are listed in the grid. Use the toolbar on the

ProductsProducts  FastTab to add products to the grid or remove them from the grid.

To make the functionality that is described in this section available in your system, you must turn on the License plate

receiving enhancements and Work policy enhancements for inbound work features in Feature management.

Previously, the system supported receiving only at the default location that is defined for each warehouse.

However, mobile device menu items that use the following work creation processes now provide the UseUse

default datadefault data option. This option lets you assign a custom "to" location to one or more menu items. (This option

was already available for some other types of menu items.)

License plate receiving (and putaway)

Load item receiving (and putaway)

Purchase order line receiving (and putaway)

Purchase order item receiving (and putaway)

The To locationTo location setting for a menu item overrides the default receiving location for the warehouse, for all

orders that are processed by using that menu item.

To set up a mobile device menu item to support receiving at a custom location, follow these steps.



TIPTIP

Example scenario: Warehouse receiving

PrerequisitesPrerequisites

Set up a work policySet up a work policy

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. Select or create a menu item that uses one of the work creation processes that are listed earlier in this

section.

3. On the GeneralGeneral  FastTab, set the Use default dataUse default data option to YesYes .

4. On the Action Pane, select Default dataDefault data.

5. On the Default dataDefault data page, set the following values:

Default data field:Default data field: Set this field to To location.

Warehouse:Warehouse: Select the destination warehouse to use with this menu item.

Location:Location: This field lists all the location IDs that are available for the selected warehouse. However,

the setting of this field doesn't actually have any effect. Therefore, you can leave it blank. Nevertheless,

you can use the list to confirm the ID that you must enter in the Hardcoded valueHardcoded value field.

Hardcoded value:Hardcoded value: Enter the location ID for the receiving location that applies to this menu item.

A work policy can be applied only if all the receiving locations are listed in the relevant work policy setup. This requirement

applies regardless of whether you're using the default warehouse receiving location or a custom "to" location.

All products that are received by the Purchase order item receiving (and putaway) process must be registered in

location FL-001, and they must be available in warehouse 24. However, work should not be created. Products

that are received by any other process (that is, by using other mobile device menu items) should be registered at

the default warehouse receiving location (RECV), and work should be created as usual. (This scenario doesn't

show the default receiving setup.)

This scenario requires the following elements:

A work policy for the Purchase order item receiving (and putaway) process in location FL-001, for all

products

A mobile device menu item that has default data, and that sets the To locationTo location field to FL-001

To make the functionality that is described in this scenario available in your system, you must turn on the

License plate receiving enhancements and Work policy enhancements for inbound work features in Feature

management.

This scenario uses the standard demo data. Therefore, if you want to work through it by using the values that

are provided here, you must work on a system where demo data is installed. Additionally, you must select the

USMFUSMF legal entity.

1. Go to Warehouse management > Setup > Work > Work policiesWarehouse management > Setup > Work > Work policies .

2. Select NewNew .

3. In the Work policy nameWork policy name field, enter No purchase item putaway work.

4. Select SaveSave.

5. On the Work order typesWork order types  FastTab, select AddAdd to add a row to the grid, and then set the following values

for the new row:



Set up a mobile device menu item to change the receiving locationSet up a mobile device menu item to change the receiving location

Receive a purchase order without creating workReceive a purchase order without creating work

Create a purchase orderCreate a purchase order

Work order type:Work order type: Purchase orders

Work process:Work process: Purchase order item receiving (and putaway)

Work creation method:Work creation method: Never

Cross docking policy name:Cross docking policy name: Leave this field blank.

6. On the Inventor y locationsInventor y locations  FastTab, select AddAdd to add a row to the grid, and then set the following

values for the new row:

Warehouse:Warehouse: 24

Location:Location: FL-001

7. On the ProductsProducts  FastTab, set the Product selectionProduct selection field to All.

8. Select SaveSave.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. In the left pane, select the existing Purchase receivePurchase receive menu item.

3. On the GeneralGeneral  FastTab, set the Use default dataUse default data option to Yes.

4. Select SaveSave.

5. On the Action Pane, select Default dataDefault data.

6. On the Default dataDefault data page, on the Action Pane, select NewNew  to add a row to the grid, and then set the

following values for the new row:

Default data field:Default data field: To location

Warehouse:Warehouse: 24

Location:Location: Leave this field blank.

Hardcoded value:Hardcoded value: FL-001

7. Select SaveSave.

The example in this section shows how to receive a purchase order item, but without creating work, at a location

that differs from the default receiving location that is set up for the warehouse. This example uses the work

policy and mobile device item that you created earlier in this scenario.

1. Go to Procurement and sourcing > Purchase orders > All purchase ordersProcurement and sourcing > Purchase orders > All purchase orders .

2. Select NewNew .

3. In the Create purchase orderCreate purchase order  dialog box, set the following values:

Vendor account:Vendor account: US-101

Site:S ite: 2

Warehouse:Warehouse: 24

4. Select OKOK to close the dialog box and open the new purchase order.

5. On the Purchase order linesPurchase order lines  FastTab, set the following values for the empty row:

Item number :Item number : A0001

Quantity:Quantity: 1

6. Select SaveSave.

7. Make a note of the purchase order number.



Receive a purchase orderReceive a purchase order

Example scenario: Manufacturing

Example scenario: Report as finished to a location that isn't license

1. On the mobile device, sign in to warehouse 24 by using 24 as the user ID and 1 as the password.

2. Select InboundInbound.

3. Select Purchase receivePurchase receive. The LocationLocation field should be set to FL-001.

4. Enter the purchase order number for the purchase order that you created in the previous procedure.

5. In the Item numberItem number  field, enter A0001.

6. Select OKOK.

7. In the QuantityQuantity  field, enter 1.

8. Select OKOK.

The purchase order is now received, but no work is associated with it. The on-hand inventory has been updated,

and a quantity of 1 of item A0001 is now available at location FL-001.

In the following example, there are two production orders, PRD-001 and PRD-002. Production order PRD-001

has an operation that is named Assembly, where product SC1 is being reported as finished to location 001.

Production order PRD-002 has an operation that is named Painting and consumes product SC1 from location

001. Production order PRD-002 also consumes raw material RM1 from location 001. Raw material RM1 is

stored in warehouse location BULK-001 and will be picked to location 001 by warehouse work for raw material

picking. The picking work is generated when production PRD-002 is released.

When you're planning to configure a warehouse work policy for this scenario, you should consider the following

points:

Warehouse work for putaway of finished goods isn't required when you report product SC1 as finished from

production order PRD-001 to location 001. The reason is that the Painting operation for production order

PRD-002 consumes product SC1 at the same location.

Warehouse work for raw material picking is required to move raw material RM1 from warehouse location

BULK-001 to location 001.

Here is an example of a work policy that you can set up, based on these considerations:

Work policy name:Work policy name: No putaway work

Work order types:Work order types: Finished goods put away and Co-product and by-product put away

Inventor y locations:Inventor y locations: Warehouse 51 and location 001

Products:Products: SC1

The following example scenario provides step-by-step instructions for setting up the warehouse work policy for

this scenario.

file:///T:/eiye/ac1a/dynamics365/supply-chain/warehousing/media/warehouse-work-policies.png


plate–controlled

Set up a warehouse work policySet up a warehouse work policy

Set up an output locationSet up an output location

This scenario shows an example where a production order is reported as finished to a location that isn't license

plate–controlled.

This scenario uses the standard demo data. Therefore, if you want to work through it by using the values that

are provided here, you must work on a system where demo data is installed. Additionally, you must select the

USMFUSMF legal entity.

Warehouse processes don't always include warehouse work. By defining a work policy, you can prevent the

creation of work for raw material picking and putaway of finished goods for a set of products at specific

locations.

1. Go to Warehouse management > Setup > Work > Work policiesWarehouse management > Setup > Work > Work policies .

2. Select NewNew .

3. In the Work policy nameWork policy name field, enter No putaway work.

4. On the Action Pane, select SaveSave.

5. On the Work order typesWork order types  FastTab, select AddAdd to add a row to the grid, and then set the following values

for the new row:

Work order type:Work order type: Finished goods put away

Work process:Work process: All related work processes

Work creation method:Work creation method: Never

Cross docking policy name:Cross docking policy name: Leave this field blank.

6. Select AddAdd again to add a second row to the grid, and then set the following values for the new row:

Work order type:Work order type: Co-product and by-product put away

Work process:Work process: All related work processes

Work creation method:Work creation method: Never

Cross docking policy name:Cross docking policy name: Leave this field blank.

7. On the Inventor y locationsInventor y locations  FastTab, select AddAdd to add a row to the grid, and then set the following

values for the new row:

Warehouse:Warehouse: 51

Location:Location: 001

8. On the ProductsProducts  FastTab, set the Product selectionProduct selection field to Selected.

9. On the ProductsProducts  FastTab, select AddAdd to add a row to the grid.

10. In the new row, set the Item numberItem number  field to L0101.

11. On the Action Pane, select SaveSave.

1. Go to Organization administration > Resources > Resource groupsOrganization administration > Resources > Resource groups .

2. In the left pane, select resource group 51025102 .

3. On the GeneralGeneral  FastTab, set the following values:

Output warehouse:Output warehouse: 51

Output location:Output location: 001

4. On the Action Pane, select SaveSave.



NOTENOTE

Create a production order and report it as finishedCreate a production order and report it as finished

More information

NOTENOTE

Location 001 isn't a license plate–controlled location. You can set up an output location that isn't license plate–controlled

only if an applicable work policy exists for the location.

1. Go to Production control > Production orders > All production ordersProduction control > Production orders > All production orders .

2. On the Action Pane, select New production orderNew production order .

3. In the Create production orderCreate production order  dialog box, set the Item numberItem number  field to L0101.

4. Select CreateCreate to create the order and close the dialog box.

A new production order is added to the grid on the All production ordersAll production orders  page.

Keep the new production order selected.

5. On the Action Pane, on the Production orderProduction order  tab, in the ProcessProcess  group, select EstimateEstimate.

6. In the EstimateEstimate dialog box, read the estimate, and then select OKOK to close the dialog box.

7. On the Action Pane, on the Production orderProduction order  tab, in the ProcessProcess  group, select Star tStar t.

8. In the Star tStar t dialog box, on the GeneralGeneral  tab, set the Automatic BOM consumptionAutomatic BOM consumption field to Never.

9. Select OKOK to save your setting and close the dialog box.

10. On the Action Pane, on the Production orderProduction order  tab, in the ProcessProcess  group, select Repor t as finishedRepor t as finished.

11. In the Repor t as finishedRepor t as finished dialog box, on the GeneralGeneral  tab, set the Accept errorAccept error  option to Yes.

12. Select OKOK to save your setting and close the dialog box.

13. On the Action Pane, on the WarehouseWarehouse tab, in the GeneralGeneral  group, select Work detailsWork details .

When the production order is reported as finished, no work is generated for putaway. This behavior occurs

because a work policy is defined that prevents work from being generated when product L0101 is reported as

finished to location 001.

For more information about mobile device menu items, see Set up mobile devices for warehouse work.

For more information about license plate receiving and work policies, see License plate receiving via the

warehouse app.

For more information about inbound load management, see Warehouse handling of inbound loads for purchase

orders.
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Create property

Create property values

NOTENOTE

Working time scheduling properties are used to categorize working time intervals and define the settings that

operators must take into account. This procedure shows how to define a working time scheduling property and

associated property values. You can walk through this procedure in demo data company USMF, or using your

own data.

1. Go to All workspaces > Resource lifecycle management.

2. Click Properties.

1. Click New.

2. In the Property field, type a value.

3. In the Name field, type a value.

1. In the list, mark the selected row.

2. In the Name field, type a value.

3. In the Value field, type a value.

4. Click Save.
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Create working time template

Replicate working times to all week days

Working time templates define the working hours throughout a week and are used to generate working times

for a period of time. This procedure shows you how to define a working time template using working time

scheduling properties for categorizing working time intervals. You can walk through this procedure in demo

data company USMF, or using your own data.

1. Go to All workspaces > Resource lifecycle management.

2. Click Working time templates.

1. Click New.

2. In the Working time template field, type a value.

3. In the Name field, type a value.

4. Expand the Monday section.

5. Click Add.

6. In the From field, enter a time.

7. In the To field, enter a time.

8. Click Add.

9. In the From field, enter a time.

10. In the To field, enter a time.

Specify the time when work begins in the morning.

Specify the time when workers break for lunch.

Specify the time when work resumes after lunch.

Specify the end of the work day.

1. Click Copy day.

2. Click OK.

3. Click Copy day.

4. In the To weekday field, select an option.

5. Click OK.

6. Click Copy day.

7. In the To weekday field, select an option.

8. Click OK.

9. Click Copy day.

10. In the To weekday field, select an option.

11. Click OK.

Copy the working times definitions from Monday to Tuesday.

Copy the working times definitions from Monday to Wednesday.

Copy the working times definitions from Monday to Thursday.

Copy the working times definitions from Monday to Friday.
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Define time slots for special operations

Mark weekend days as closed for pickup

NOTENOTE

1. Expand the Friday section.

2. In the list, find and select the desired record.

3. In the Property field, enter or select a value.

4. In the list, find and select the desired record.

5. In the Property field, enter or select a value.

1. Expand the Saturday section.

2. Select Yes in the Closed for pickup field.

3. Expand the Sunday section.

4. Select Yes in the Closed for pickup field.
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Define default operational parameters

Define operating hours

Add operations resources

NOTENOTE

A resource group is a set of operations resources that typically correspond to the physical organization of work

cells, defined by yellow lines on the production shop floor. This procedure shows you how to define a ressource

group for use in discrete production. You can walk through this procedure in demo data company USMF, or use

your own data.

1. Go to Resource groups.

2. Click New.

3. In the Resource group field, type a value.

4. In the Description field, type a value.

5. In the Site field, enter or select a value.

6. In the Production unit field, enter or select a value.

1. Expand the Operation section.

2. In the Scrap percentage field, enter a number.

3. In the Setup category field, enter or select a value.

4. In the Run time category field, enter or select a value.

5. In the Operations scheduling percentage field, enter a number.

1. Expand the Calendars section.

2. Click Add.

3. In the Calendar field, enter or select a value.

1. Expand the Resources section.

2. Click Add.

3. In the Resource field, enter or select a value.

4. Click Add.

5. In the Resource field, enter or select a value.

6. In the list, find and select the desired record.

7. In the list, click the link in the selected row.
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Create a new production flow version

Add an existing activity

NOTENOTE

When creating new versions of production flows, you can choose to add activities created for the older versions,

to the new version. This procedure shows how a new version is created for an existing production flow, without

copying the activities. In the next step, an existing activity is added to the new version.

This task requires production flow with version and activities already created.

1. Go to Production control > Setup > Lean production flow > Production flows.

2. In the list, find and select the desired record.

3. In the list, click the link in the selected row.

4. Click Edit.

5. In the list, mark the selected row.

6. In the Expiration date field, enter a date and time.

7. Click Add.

8. Select No in the Copy from version field.

9. Select No in the Duplicate kanban rules field.

10. Click OK.

11. In the list, find and select the desired record.

Note that before you create a new production flow version, make sure to check the expiration date

and time of the active version. The new version will be created with an effective start date, which

connects to the expiry date of the selected version.

Select No to start with an empty version if most of the activities of the copied version will be replaced

by new activities. Add the unchanged activities to the Add existing function in the activity form

manually.

When the activities are not copied to the new version, it is not possible to copy the kanban rules at the

time of creation of the new version. Instead you will use the create replacement kanban function later

in the kanban rule form, to replace kanban rules of the old production flow version with kanban rules

using the activities of the new version.

1. Click Activities.

2. Click Add existing to open the drop dialog.

3. In the Activity field, enter or select a value.

4. Click OK.

Find and select an existing activity to be added to the new production flow version. Note that the list

shows all activities that have been created for this production flow for all previous versions of the flow.
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Deactivate a production flow version

NOTENOTE

When an active production flow version is no longer needed, it can be deactivated. You should only use this

option if all kanban rules and activities have ended and will not be activated again. Note that the expiry date of

all kanban rules related to this production flow version will be updated with the current date and time.

To modify an active production flow version, consider setting an expiry date for the active version and create a

new version. This will allow you to continue your production operations while preparing the new version and

related kanban rules.

To expire an active production flow version, you need to set an expiry date. In that sense, deactivation is more

like an exception than a rule.

For this procedure you need a production flow with a version that can be deactivated. Do not try this in a

production environment unless you are 100% positive that the version is fully obsolete.

1. Go to Production control > Setup > Lean production flow > Production flows.

2. In the list, find and select the desired record.

3. In the list, click the link in the selected row.

4. In the list, find and select the desired record.

5. Click Deactivate.

6. Click OK.

Do not proceed if you are not 100% positive that this production flow version is obsolete. Clicking Ok

will expire all active kanban rules and put an immediate stop to all production and replenishment

activities of this production flow version.
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Set an expiration date to end a production flow version

NOTENOTE

To end the validity and the processing of a production flow version on a given date, or to plan replacement of an

active version with a new version, you have to set an expiry date on the version. It is not necessary to deactivate

the version.

1. Go to Production control > Setup > Lean production flow > Production flows.

2. In the list, find and select the desired record.

3. In the list, click the link in the selected row.

4. Click Edit.

5. In the list, mark the selected row.

6. In the Expiration date field, enter a date and time.

Select any production flow that has a version that is already defined.

For the expiration date, a new version will not start or become activated. It will also no longer be

possible to create or start jobs for this production flow. You can still complete started jobs after the

expiration date.
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Define a production flow model.

Production flow models describe how the capacity of lean manufacturing work cells is calculated and

maintained. Therefore the definition of a production flow model is a prerequisite of the definition of work cells.

The demo data company used to create this procedure is USMF.

1. Go to Production control > Setup > Lean production flow > Production flow models.

2. Click New.

3. In the Production flow model field, enter an ID for the production flow model.

4. In the Model type field, select an option.

5. Enter the number of days in the EPE Cycle.

6. In the Planning period type field, select an option.

7. In the Planning time fence field, enter a number.

8. In the Capacity shortage reaction field, select an option.

There are two model types: Throughput type and Hours type. For Throughput type, the capacity of

work cells that use this production flow model will be expressed and calculated in product quantities.

For Hours type, the capacity of work cells that uses this production flow model will be expressed and

calculated in hours. Note that this property can't be changed for an existing production flow model.

After a work cell has capacity reservations, the production flow model type can't be changed.

The interval describes the period when every part produced by a production flow or work cell will be

produced at least once. The shorter the EPE cycle, the more flexible the production process is. If EPE

Cycle = 0, all demand can be produced in the same day. The EPE Cycle is used to schedule lean

process jobs. When scheduling a job on a work cell with EPE Cycle = 5, the scheduling process will

look for capacity on the work cell at Due date - EPE Cycle (5 days ahead of the due date) to ensure that

the product can be produced in that cycle. The inventory lead time of a product is usually equal to or

greater than the EPE Cycle of the related production process.

After a work cell has capacity reservations, the planning period type cannot by changed. You can only

select production flow models with the same period type for this given work cell.

The planning time fence describes the number of days where capacity reservations can be made for

the related work cells. In the Planning time fence, enter the number of days. Kanban process jobs that

fall outside of this period are not planned with automatic planning. The planning time fence is typically

two times the average inventory lead time of the products produced in a production flow or work cell.

The EPE Cycle should not be more than half the planning time fence.

The options include: Postpone - Postponing the full demand of the scheduling event on the next

available production day, with available throughput. Cancel - End the automatic planning for the

scheduling event and leave the related jobs unplanned. Add to requested day - Plan the requested

jobs for the requested period. This overloads the cell for this day and requires the planner to review

and to a manual interaction . Distribute to available periods - Distribute the different jobs of the

scheduling event to all available production days, beginning from the first available day. The minimum

distribution quantity is the kanban job quantity. The distribution assigns the minimum planning

quantity (kanban quantity) to every day with enough available throughput.
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Components of operations scheduling

Scheduling direction and date

This topic provides information about operations scheduling. You can use operations scheduling to provide a

general estimate of the production process over time.

You can schedule production at the operation level and the job level. Unlike job scheduling, operations

scheduling doesn't explode the operations for the production route into jobs. If you want to include more detail

in the scheduling, such as information about current capacity, you can run job scheduling after you run

operations scheduling. You can also run job scheduling only. Job scheduling is typically used to schedule

individual jobs on the shop floor for an immediate or short-term time frame.

The main components of operations scheduling are the scheduling direction, the capacity of resources, and

materials optimization. By using operations scheduling, you can achieve the following goals:

Control the planning method by scheduling forward or backward from a given date.

Optimize the use of resources by scheduling productions based on the capacity of the resources. This

approach also helps identify when alternative resources should be used.

Optimize the use of materials by scheduling productions based on the availability of the required materials.

Schedule and synchronize reference productions. The dates of the reference productions are adjusted when

the production order ’s schedule is changed.

You must estimate the cost of a production order before you can run operations scheduling. If you haven't run

an estimate, it's automatically run before operations scheduling is started. An operations schedule specifies the

following information:

The product that is planned for production

The configuration of the product

The quantities that are involved in the production

The dates when the production will start and end

The capacity reservations for the resources that perform the production activities

The setup time, process time, and run time are set for operations in the production. After you run operations

scheduling, the status of the production order is ScheduledScheduled, and all operations are scheduled in the order that

is specified by the production route. However, only the duration of the operation is considered. Start times and

end times aren't scheduled.

The scheduling direction is fundamental to the scheduling process. Production can be scheduled forward or

backward from any date, depending on timing and scheduling requirements.

For ward from the scheduling dateFor ward from the scheduling date – You can schedule production to start as early as possible.

Production can be started today, tomorrow, or on any date in the future. The production is scheduled forward

in time to the earliest possible end date.

Backward from the scheduling dateBackward from the scheduling date – You can schedule production to start as late as possible. Backward

scheduling is based on the date when the production must be completed. The schedule counts backward

from that date to the latest possible date that the production can be started and still be completed on time.
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Resource scheduling

Operations scheduling and master planning

NOTENOTE

Cancellations

Finite materials

Additional resources

NOTENOTE

When you run an operations schedule, each operation in the production route is scheduled for the resource that

is specified for the operation. Additionally, the duration of each operation is specified on the production route. If

a resource group is specified for an operation, the scheduling reserves capacity on the group. However, unlike

job scheduling, operations scheduling doesn't select the specific resources in the group. If you're working with

finite capacity, the schedule depends on the availability of the resources that are required in order to complete

production. Operations scheduling follows the sequence of operations that is specified on the production route.

The scheduling reserves capacity on the resource groups, based on the operation times that are defined on the

production route. The sum of available capacity on the resources that are involved determines the capacity for

the resource group. Capacity reservations that already exist for the resources are considered unavailable

capacity. If there isn't enough available capacity for the production, the production orders can be delayed or

even stopped. You can also specify the efficiency that you expect from the resources that are involved in the

production. You specify the efficiency as a percentage on the resource. The efficiency percentage adjusts the

throughput of the resource. This adjustment affects the time that is reserved for the resource. The lead times for

the operations that use the resource are also adjusted accordingly.

The operations schedule also drives master planning and determines calculations for material requirements.

Operations scheduling considers the following information:

Backlogged productionsBacklogged productions  – Products that are planned, released, or started

Material availabilityMater ial availability  – Inventory, subproductions, suppliers, and vendors

Capacity availabilityCapacity availability  – Resources that are required for production

If you're using multi-threaded master planning and operations scheduling, finite capacity will not be considered.

When you run operations scheduling, you can cancel specific parts of the routing. These parts include the queue

time, setup time, process time, overlap time, and transport times.

If you're working with finite materials, scheduling also depends on the availability of the materials that are

required for production. If there aren't enough available components for the production, production can be

delayed. You can base scheduling on the use of materials by specifying the materials that must be available for

production. When you optimize on both resource capacity and the availability of materials, production is

calculated according to these restrictions. A production order can't be scheduled to start until capacity and

materials are available at the same time and in the required quantities.

Operations scheduling options
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Tasks in the job scheduling process

Scheduling direction

Finite capacity

This article provides information about job scheduling, which is a more detailed form of scheduling than

operations scheduling. You can use job scheduling to schedule individual jobs or shop orders, and to control the

manufacturing environment.

You can use job scheduling to schedule individual jobs or shop orders, and to control the manufacturing

environment. Job scheduling breaks down each operation into its individual tasks or jobs. These jobs are then

assigned to the operations resources that will perform them. Job scheduling also lets you synchronize all jobs

that are referenced by the selected job. You can specify a start date and time or end date and time for the job,

and then run scheduling. The time that you specify can be the start time or the end time, depending on the

scheduling direction. This functionality is useful when, for example, a job can be run only on one machine at a

time, or when you want to optimize the job that is run for each resource.

The job scheduling process includes the following tasks:

Split operations into jobs.

Schedule jobs, based on the dates and times for the resources that are specified for the related operation.

Calculate start times and end times for each job. You can use finite capacity to make sure that there are no

overlapping times.

Determine which resources in the resource group to run the job on. This task requires that a resource group

be specified for an operation. Job scheduling selects the resources or resource groups based on the shortest

lead time, and also considers any previous reservations on the resources.

Explode operations into jobs when you run job scheduling. The jobs are scheduled by date and time,

according to the order that is specified by the production route. The setup of the operation determines the

jobs that are exploded during the scheduling process. The route group that is assigned to the operation

controls whether jobs are generated. A job is generated only if it has a specific duration. For example, a

transport time job is generated if a transport time was specified for the selected operation.

You can schedule jobs either forward or backward.

For wardFor ward – Use the forward scheduling direction to start the production as early as possible. This is also

known as the push method, because the production is being pushed forward through the production

process. The production is scheduled to start and end on the earliest possible dates.

BackwardBackward – Use the backward scheduling direction to start the production as late as possible. This is also

known as the pull method, because it's based on the date when the production must be completed. Backward

scheduling counts backward to the latest possible date that the production can be started without missing its

target deadline.

You can schedule jobs by using finite capacity. When you use finite capacity, the capacity that is scheduled can't

be larger than the capacity that is available for the resource. Available time is defined as the interval when the

resource is available and there are no other reservations on capacity. Scheduling that is based on finite capacity

makes sure that start times and end times for an operation on a specific date don't overlap. The resource

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/job-scheduling.md
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capacity that is already reserved is considered, and overlaps between the start times and end times are also

considered. Finite capacity determines the amount of capacity that must be available for a resource in order to

achieve optimal use of that resource. This determination is balanced against a calculation of the shortest

possible lead time between operations.

Job scheduling that is based on finite materials makes sure that the required materials are available when the

operation starts. The coverage rules for items define these limits. Scheduling uses requirement explosion to

determine when the component items are available. If you schedule without setting finite materials, the system

assumes that all items are available when they are required.

Job scheduling that is based on special properties requires that properties be specified for the operations on the

production route. These properties must be fulfilled to reserve capacity.

Job scheduling schedules all productions that are referenced by the current production. If a production has one

or more subproductions, the subproductions should be scheduled at the same time as the main production,

because the main production can't be started until the related subproductions are completed.

The scheduling engine examines combinations of resources to identify those combinations that can satisfy

requirements. You can specify selection criteria by selecting one of the following values in the Pr imar yPrimar y

resource selectionresource selection field on the Scheduling parametersScheduling parameters  page:

DurationDuration – The scheduling engine selects the resource that has the shortest lead time. Note:Note: Scheduling by

duration can cause decreased performance when the same resource group contains many resources and

secondary operations are used. You can schedule a maximum of 32 resources per operation. If you exceed

this quantity, an Infolog message is displayed, and job scheduling doesn't find the best alternative resource.

Pr ior ityPr ior ity  – The scheduling engine selects the resource that has the highest priority if two or more resources

have identical capabilities and levels. The resource that has the lowest numeric value in this field has the

highest priority.

When job scheduling is run, the system plans the resources, based on the limitations that are defined in the

resource parameters. You can control the capacity of the resources by using calendar settings. The system

calculates loads for resources during the scheduling process. Note:Note: For productions that use the operations

scheduling function, you can run job scheduling after operations scheduling. If you aren't using operations

scheduling, you can run job scheduling alone.

Resources are assigned to jobs through job scheduling. You can establish maximum capacities for resources per

job order. For example, you can set up the system to schedule no more than 50 percent of total capacity for a

production order. This setup gives you more control over the scheduling of resources on the job scheduling

level. Therefore, it can help prevent issues if not enough capacity is available to perform simultaneous

productions.

Job scheduling considers the efficiency percentages that are specified for the resources. Efficiency percentages



NOTENOTE

reduce or increase the time that is reserved for the resource. Therefore, lead time is also increased or decreased.

The following formula is used for the calculation: Scheduling time = Time × 100 ÷ Efficiency percentage In this

formula, Time includes both the run time and the setup time.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Order view

Resource view

The Gantt chart is designed to empower production planners to control and optimize the production plan. The

Gantt chart makes the flow of operations transparent and makes it easy to adjust the production schedule while

taking into account material or resource shortages. This helps planners make the best use of available resources,

minimize work in progress, and optimize throughput times for production orders.

A Gantt chart is a visual representation of scheduled activities within a defined time interval. The activities are

scheduled on resources that have capacity defined by a capacity calendar. The following types of activities can be

shown in the Gantt chart.

Jobs from production orders that are job scheduled.

Jobs from planned production orders.

Job scheduled project activities of type Hour forecasts.

The Gantt chart can be opened in two different views, Order viewOrder view  and Resource viewResource view . In Order viewOrder view ,

activities are grouped under production orders. This can be useful, for example, if you want to maintain an

overview of all the jobs belonging to the same orders. In Resource viewResource view  all jobs are grouped under individual

resources. This view can be useful when optimizing the plan at a resource level, for example, a machine or a

group of machines. The Gantt charts shown in the illustrations below show Order viewOrder view  and Resource viewResource view

with these key elements:

1. Gantt chart activity

2. Material shortage icon

3. Material availability icon

4. Order delivery date icon

5. Capacity bar

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/visual-scheduling-production.md
file:///T:/eiye/ac1a/dynamics365/supply-chain/production-control/media/orderview.png


Activities

Material availabilityMaterial availability

The activities appear as bars and are organized in a time scale grid with a scheduled start and end time, making

the length of the bars proportional to the time that is necessary to complete the activity. The activities are shown

according to a time scale. You can adjust the time scale on the menu where you select a start and end date and a

time unit, for example, hours or days. By adjusting the time scale you can set focus on a time interval in which

you want to manage activities.

To get a better overview, there are different options for controlling the color of the activities. You can configure

an individual color for activities, use the theme color that is the general color theme used for the application, or

set up the color to be controlled by the color code for production orders.

The time interval for activities has a background shade. Periods with a white shade indicate a time interval with

defined capacity on the resource for the activity, whereas periods with a grey shade indicate time intervals with

no capacity defined.

On the left side of the chart there is additional information about the activity, for example, the resource on which

the activity is scheduled and production order number. The connection between jobs belonging to the same

order is shown with an arrow.

You can get more information about an activity in the activity dialog box. To open the dialog box, double-click

the activity or select the informationinformation menu. In the activity dialog you can see the scheduled start and end date,

and time information about which materials the activity is planned to consume.

The activities can be grouped in Grouping levels. The Grouping levels are hierarchical and can be used to make a

logical grouping of activities. For example, if you have a layout where manufacturing activities are grouped by

Site, Production units, Resource groups, and Resources, you can use the Grouping levels to group the activities

according to that layout. The grouping levels can be expanded and collapsed either on the individual grouping

level or for all levels in the chart by using the Expand allExpand all  and Collapse allCollapse all  buttons on the menu. You can also

configure the grouping levels to be expanded or collapsed when the chart is opened.

The Gantt chart can be set up to provide the planner with detailed information about material status for the

individual activities. For example, this can be helpful if material is delayed and is affecting the production plan. In

this case, the material issues will be highlighted in the Gantt chart to help the planner to understand

consequences and make necessary adjustments.

A job will appear with a material shortage icon if the schedule start date of the job is later than the material

availability date for materials consumed by the job. The material availability date is calculated based on the

pegging information in the dynamic master plan. The material shortage icon will for example appear on a job

that is consuming a material that is pegged against a purchase order that has a receipt that is later than the

planned start date of the job.

file:///T:/eiye/ac1a/dynamics365/supply-chain/production-control/media/resview.png


Indicator of material availability dateIndicator of material availability date

Indicator of order delivery dateIndicator of order delivery date

Capacity barCapacity bar

Job scheduling in the Gantt chart

Schedule a job as a drag-and-drop interactionSchedule a job as a drag-and-drop interaction

Schedule a job from the menuSchedule a job from the menu

Schedule previous jobsSchedule previous jobs

When you set up the chart to show jobs with material shortages an icon for showing the material availability

date for the job can also be shown. The icon will only be shown if the material availability date is within the

defined time interval of the chart. If the material availability date lies outside the defined time interval, then

more detailed material availability information can be retrieved from the material list in the job dialog box. In

the list there is also an icon showing late materials for the job. You can reschedule a job using the material

availability date as a start date.

This icon indicates the delivery date for a production order. The icon is only visible in the Order view.

You can configure the chart to show a resource capacity bar. This bar provides an overview of the resource

capacity for an activity in the defined time interval of the chart. The capacity bar is not shown for periods of the

time where the resource is not booked. In periods where the resource is booked to capacity, the capacity bar is

shown as a solid bar. In periods where the resource is overbooked, the bar will appear thicker and in a red color.

For example, if two jobs overlap, the capacity bar will indicate an overbooking in the time interval where there is

an overlap. The capacity bar is updated dynamically when you schedule a job. You enable the capacity bar on the

Show capacity barShow capacity bar  menu. It can only be shown in Resource viewResource view . If you want to get a more detailed view of

the capacity load on a resource, use the Capacity loadCapacity load chart, which can be opened from the menu or the

context menu for a selected activity.

The Gantt chart offers different options for making adjustments to the production plan. In the Gantt chart, you

can re-schedule activities as a drag-and-drop interaction or from a schedule menu. In the planning process, you

can take resource capacity, resource capabilities, and material constraints into account.

You can re-schedule job within the defined time interval as a drag-and-drop interaction. You can only re-

schedule the job on the same resource, and you can only schedule one job at a time.

On the Schedule jobsSchedule jobs  menu, you can schedule one or more selected job in the chart based on a scheduling

direction and a scheduling date time. There are three available schedule directions.

Forward from scheduling date

Backward from scheduling date

Forward from material availability date

It is not possible to schedule a job outside the defined time interval of the Gantt chart. If you do that, the job will

be left unscheduled and you will receive the error message, "Could not schedule the job within the loaded time

period."

In a network of activities, such as jobs belonging to the same production order, you can use the ScheduleSchedule

previous jobsprevious jobs  function to schedule the previous jobs relative to a selected job in the network. In the following

example, the highlighted activity is the selected job. The diagram shows before a previous job is scheduled and

after the previous job is scheduled.



Schedule next jobsSchedule next jobs

Schedule around jobSchedule around job

You can use the Schedule next jobsSchedule next jobs  function to schedule the next jobs relative to a selected job in a network of

activities. In the following example, the highlighted activity is the selected job. The diagram shows before the

next job is scheduled and after the next job is scheduled.

You can use the Schedule around jobSchedule around job function to schedule the next job and the previous job relative to a

selected job in a network of activities. In the following example, the highlighted activity is the selected job. The

diagram shows before a job is scheduled and after the job is scheduled.

file:///T:/eiye/ac1a/dynamics365/supply-chain/production-control/media/schprevjob3.png
file:///T:/eiye/ac1a/dynamics365/supply-chain/production-control/media/schnxtjob.png


Arrange jobsArrange jobs

Reassign activities from one resource to anotherReassign activities from one resource to another

Reassigning an activity as a drag-and-drop interactionReassigning an activity as a drag-and-drop interaction

Reassigning an activity from the Schedule jobs menuReassigning an activity from the Schedule jobs menu

You can use the ArrangeArrange function to arrange selected activities on the same resource. These activities can be in

the same network of activities, but can also belong to different networks. When you use the arrange function the

time gaps between the selected activities will be eliminated. You can use this function to optimize the capacity

utilization of the resources. The diagram shows before a job is scheduled and after the job is scheduled.

You can reassign a job from one resource to another. This can be useful in situations where a machine is out of

order or overbooked, and you need to find another available resource that can do the job.

In the ResourceResource view, you can reassign an activity to a different resource in the Gantt chart as a drag-and-drop

interaction. You do that by selecting the row in which the activity is scheduled. After the row is selected you can

drag the row to the resource in the chart grouped under a different resource grouping level.

You can reassign a job from the Schedule jobSchedule job dialog box opened from the Schedule jobSchedule job menu. From this

menu you can only reassign a job to a resource that is already loaded to the Gantt chart. If you only select one

job, then the drop down for the resource will be sorted by applicable resources. If you select more jobs, then

file:///T:/eiye/ac1a/dynamics365/supply-chain/production-control/media/scharoundjob1.png
file:///T:/eiye/ac1a/dynamics365/supply-chain/production-control/media/arrangejobs1.png


Load additional resources to the Gantt chart

Access the Gantt chartAccess the Gantt chart

PA GEPA GE DESC RIP T IO NDESC RIP T IO N

Production order list and detailProduction order list and detail On the Production order list and detailProduction order list and detail page, you can
open the Gantt chart from one or more selected orders.
Opening the chart from the Gantt char tGantt char t  menu item will
load all jobs related to the selected production orders, but
also jobs from other production orders that are scheduled
on the same resources. Opening the chart from the GanttGantt
char t – Fast viewchar t – Fast view menu item will only load jobs related to
the selected production orders. In this view, it is not possible
to schedule jobs.

ResourceResource On the ResourceResource page, you can open the Gantt chart from
the menu item Gantt char tGantt char t . When selected, all the jobs
scheduled on the resource in a selected time interval will be
loaded to the chart.

Resource groupResource group On the Resource groupResource group page, you can open the Gantt
chart from the menu item GanttGantt  chart. When selected, all
the jobs scheduled on the resources in the resource group
will be shown in a selected time interval.

Gantt char tsGantt char ts On the Gantt char tsGantt char ts  page you can configure Gantt charts
by resources and resource groups. For example, if you want
to control production activities for specific sets of resources
or resource groups, then you can make individual
configurations of those on the Gantt char tsGantt char ts  page. You can
then open the Gantt chart from each configuration.

Hour forecastsHour forecasts  (project) Project activities of type Hour forecastHour forecast  can be job
scheduled on resources. On the Hour forecastHour forecast  page on the
SchedulingScheduling menu you can open the Gantt chart on an
order to see job scheduled project activities of type hour
forecast.

Job to completeJob to complete (List in Production floor managementProduction floor management
workspace)

The Jobs to complete list in the Production floorJobs to complete list in the Production floor
managementmanagement  workspace shows jobs from production and
batch orders that are in progress on the selected resources
for the workspace. On the Gantt char tGantt char t  menu item you can
open the Gantt chart, where all the jobs selected in the list
will be loaded to the chart.

there will be no information about applicable resources from the resource list.

In the Resource viewResource view , you have an option to load additional resources to the Gantt chart. This can be useful if

you want to find an alternative resource for a job that is scheduled on a machine that is overbooked or broken

down. On the Load additional resourcesLoad additional resources  page, you will get a list of resources that are date efficient as of the

date the list is opened. Applicable resources, relative to a selected job in the Gantt chart, will be listed first. If you

have multiple jobs selected, prior to opening the list, no indication of applicable resources will be shown. On the

Load additional resourcesLoad additional resources  page, you can select one or more resources, that will be loaded to the Gantt chart

when you confirm your selection. If there are no jobs scheduled on the selected resource in the time interval of

the Gantt chart, then the resource will be placed under a resource grouping level in the bottom of the list of

activities in the Gantt chart.

The Gantt chart can be opened from the following pages.



Production orders to releaseProduction orders to release (Opened from the
Production floor managementProduction floor management  workspace)

The production orders to release page is opened from the
Production floor managementProduction floor management  workspace. This page
shows scheduled production and batch orders pending
release. On this page you can open the Gantt chart for
selected production orders.

PA GEPA GE DESC RIP T IO NDESC RIP T IO N

Additional resources

NOTENOTE

Visual scheduling with Gantt chart for production and batch orders (Video)

Visual scheduling for production (demo script)

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://youtu.be/BtbuShkGj4I
https://docs.microsoft.com/en-us/dynamics/s-e/
https://aka.ms/BAG_Docs_Language_Survey
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Operations scheduling
Scheduling directionScheduling direction

This topic describes the options for operations scheduling. You can use operations scheduling to provide a

general estimate of the production process over time.

Operations scheduling calculates the following information for a production order :

Start and end dates are set for the production order and each operation.

Resources are assigned to operations.

Several settings determine how production schedules are calculated. You define these settings on the

Operations schedulingOperations scheduling page. The following information describes the scheduling options.

The scheduling direction is fundamental to the scheduling process. A production can be scheduled forward or

backward from any date, depending on timing and scheduling requirements.

For ward schedulingFor ward scheduling – You can schedule a production to start as early as possible. The production can be

started today, tomorrow, or on any specific date in the future. The production is scheduled to start on the

earliest possible date and is planned forward in time to the earliest possible end date.

Backward schedulingBackward scheduling – You can schedule a production to start as late as possible. The schedule is based on

the date when the production must be completed and counts backward to the latest possible date that the

production can be started without missing its target deadline.

The following options are available:

For ward from todayFor ward from today  – Schedule forward from the current date. (The current date is the system date.)

For ward from planned star tFor ward from planned star t – Schedule forward from an earlier start date. If there is no previous

scheduling, the scheduling direction is forward from the current date.

For ward from scheduling dateFor ward from scheduling date – Schedule forward from the date that is specified in the SchedulingScheduling

datedate field. If you don't specify a scheduling date, the scheduling direction is forward from the current date.

Backward from deliver y dateBackward from deliver y date – Schedule backward from the delivery date that is specified for the

production order. If you select this option, but no delivery date is specified, the delivery date is the current

date.

Backward from planned endBackward from planned end – Schedule backward from a previously calculated end date. If there is no

previous scheduling, the end date is the current date.

Backward from scheduling dateBackward from scheduling date – Schedule backward from the date that is specified in the SchedulingScheduling

datedate field. If you don't specify a scheduling date, the current date is used. Backward from scheduling date is

calculated for the production order the last time that a requirement was calculated. If no date is specified for

the production order, the current system date is used.

Backward from futures dateBackward from futures date – Schedule backward from the futures date that was calculated for the

production order the last time that a requirement was calculated. If no futures date is specified for the

production order, the current system date is used.

As last schedulingAs last scheduling – For operations scheduling and job scheduling, the selected scheduling direction and

date are saved. Therefore, you can select this option for subsequent scheduling. If there is no previous

scheduling of the production order, scheduling is backward from the current system date.

For ward from tomorrowFor ward from tomorrow  – Schedule forward from the current date plus one day.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/operation-scheduling-options.md


Scheduling dateScheduling date

Recalculate BOM levelsRecalculate BOM levels

Limitations
Finite capacityFinite capacity

Finite materialFinite material

For ward from previous jobFor ward from previous job – This option is relevant only in job scheduling. If you select this scheduling

direction for operations scheduling, the production order is scheduled forward from the current date. In job

scheduling, scheduling is established for one job, and all other jobs for the production are scheduled based

on that job.

Backward from previous jobBackward from previous job – This option is relevant only in job scheduling. If you select this scheduling

direction for operations scheduling, planned orders are scheduled backward from the current date. In job

scheduling, scheduling is established for one job, and all other jobs for the production are scheduled based

on that job.

This date is used for the For ward from scheduling dateFor ward from scheduling date and Backward from scheduling dateBackward from scheduling date scheduling

directions. Scheduling is backward or forward from this date. For more information, see the previous section,

"Scheduling direction."

When you select Recalculate BOM levelsRecalculate BOM levels , the selected bill of materials (BOM) levels will be recalculated to

help guarantee the correct scheduling order.

Scheduling depends on the availability of the resources that are required in order to complete production. If

there isn't enough capacity, production orders can be delayed or even stopped. If finite capacity is applied to

operations scheduling, existing capacity reservations that are made on the resources are considered, and that

capacity is seen as unavailable. The production order is scheduled based on the availability of capacity on the

resources that are required. Operations scheduling uses the specified sequence of operations to determine the

order of operations in the production route. Operations scheduling reserves capacity on the resource groups,

based on the operation times that are defined on the production route. The capacity of the resource groups is

the sum of available capacity on all the resources in the resource groups.

Scheduling also depends on the availability of the materials that are required for production. Insufficient

component availability can also cause production delays. Scheduling can also be based on the use of materials.

Just specify the materials that must be available for production instead of the materials that aren't critical. This

type of scheduling is known as scheduling with finite material. When you specify finite materials, production is

scheduled based on whether materials are available. Note:Note: When you optimize on both capacity and materials,

production is calculated to meet both restrictions. The availability of capacity and materials is considered, and

the production order ’s operations can't be scheduled to start until capacity and materials are available at the

same time and in the required quantities. Select this check box if materials should be considered limited during

scheduling. If the materials are limited, the material's coverage for that time will be considered. In other words,

scheduling considers the futures dates that are calculated for the items. Scheduling reserves raw materials and

explodes the current production. If scheduling occurs several times, only the first scheduling runs an explosion

and makes reservations. If you make changes in the production BOM or route, the next scheduling runs an

explosion. For the explosion, it's assumed that the materials are required on the same day. Because the

production isn't scheduled at the time of the master schedule explosion, the current date is the best estimate of

when the items will be available. The explosion then checks whether the items are available. If the items are

available, the production requirement can be fulfilled. If the items aren't available by the current date, a planned

order is generated, and an offset selection is made for the planned order. If automatic firming is set for the

planned order, the planned order is firmed automatically for purchase or production. The production status is

automatically changed to the status that is specified in the Requested production statusRequested production status  field in the

Coverage groupsCoverage groups  dialog box. If the check box is cleared, the materials are always considered available.

Therefore, scheduling doesn't consider whether the materials are available at the time of requirement.



Finite propertyFinite property

Keep production unitKeep production unit

Keep warehouse from resourceKeep warehouse from resource

References
Schedule referencesSchedule references

Synchronize referencesSynchronize references

Cancellation
Cancel queue timeCancel queue time

Cancel setupCancel setup

Cancel processCancel process

Cancel overlapCancel overlap

Cancel transportCancel transport

Set default

Select this check box if the job scheduling should include property requirements.

Select whether the scheduling engine should schedule only resources that are already specified on the

production unit.

Select whether the scheduling engine should schedule only resources that are associated with the input

warehouse that is specified on the resource.

When references depend on production orders, they are also known as subproductions. Subproductions can be

scheduled as part of the scheduling of a production order. Select this check box if the scheduling of

subproductions should be based on the scheduling of the main production. In relation to the main production,

overlying productions are scheduled forward, and underlying productions are scheduled backward. You can

view production order references can be viewed in the Reference levelReference level  field on the Production ordersProduction orders  page.

You can synchronize references with the production order. If this option is selected, the dates of the

subproductions are moved and aligned when changes are made to the production order ’s schedule. If a

production order has one or more subproductions, you might want to schedule the subproductions together

with the main production. In this case, the main production can't be started until the related subproductions

have been completed. Therefore, select this check box if the scheduling of subproductions should be based on

the start and end times of the selected production. You can select this check box only if the ScheduleSchedule

referencesreferences  check box is also selected.

Select this check box to exclude queue time from the scheduling.

Select this check box to exclude setup time from the scheduling.

Select this check box to exclude run time from the scheduling.

Select this check box to exclude overlap time from the scheduling.

Select this check box to exclude transit time from the scheduling.

You can save the current values as default values. There are two options:

Set as my default

Set as default for everyone
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Operations scheduling
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Schedule a production order with operations and
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Create a production order

Schedule operations for the production order

Schedule jobs for the production order

NOTENOTE

This topic focuses on scheduling a production order with operations scheduling and job scheduling. No jobs are

created with operations scheduling whereas jobs are created with job scheduling. The demo data company used

to create this task is USMF. This procedure is intended for the production manager, production planner, or shop

floor supervisor working in a discrete manufacturing environment.

1. In the navigation pane, go to Modules > Production control > Production orders > All productionModules > Production control > Production orders > All production

ordersorders .

2. Select New production orderNew production order .

3. In the Item numberItem number  field, enter or select a value. Select Item number D0001D0001 .

4. Select CreateCreate.

1. Mark the newly created row.

2. On the Action Pane, select ScheduleSchedule.

3. Select Schedule operationsSchedule operations .

4. In the Scheduling directionScheduling direction field, select For ward from scheduling dateFor ward from scheduling date.

5. In the Scheduling dateScheduling date field, enter a date. Select a future date, for example, today plus one week. With the

selected Scheduling direction, the production order will be scheduled forward from this date.

6. Select OKOK.

7. In the list, mark the selected row. Note that the status is changed to ScheduledScheduled.

8. Select All jobsAll jobs . Note that no jobs are created with operations scheduling.

9. Close the page.

1. On the Action Pane, select ScheduleSchedule.

2. Select Schedule jobsSchedule jobs .

3. In the Scheduling directionScheduling direction field, select For ward from scheduling dateFor ward from scheduling date.

4. In the Scheduling dateScheduling date field, enter a date. Select a date in the future, for example, today plus one week.

With the selected Scheduling direction, the production order will be scheduled forward from this date.

5. Select OKOK.

6. On the Action Pane, select Production orderProduction order .

7. Select All jobsAll jobs . Note that based on the active route, 5 jobs are created with job scheduling.

Can you tell us about your documentation language preferences? Take a short survey.
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NOTENOTE

When a production order is created, a request is initiated to start producing an item. The production order

contains information about what will be produced, the quantity to produce, and the planned finish date. It also

contains information about which materials to consume and which process to follow to produce the item.

A production order passes through stages of the production life cycle. When an order is created, it is assigned

the status CreatedCreated. When an order is finished, it is assigned the status EndedEnded. A parameter setting in each stage

allows a user to configure each step. The setting can be set up for a single user or for all users.

The production bill of material and the production route are the main entities of the production order. They are

copied to the production order based on the selected item and quantity that are going to be produced. Before

the production order is started, the production bill of material and route can be edited.

A production order can be created in the following scenarios:

Created by master planning execution based on material demand.

Created directly from a sales order line or when a higher-level production order is created and estimated

(pegged supply).

Created manually.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a production order

Validate the production order

Update the BOM

This procedure shows how to create a production order. The demo data company used to create this procedure

is USMF. This is the first procedure out of seven which explains the production order lifecycle.

1. Go to Production control > Production orders > All production orders.

2. Click New production order.

3. In the Item number field, type 'D0001'.

4. In the Delivery field, enter a date.

5. Set Quantity to '20'.

6. Click Create.

The delivery date indicates when the production order should end in order to deliver on time. This

date can be used in the scheduling process. For example, you can schedule the order backward from

the delivery date.

Note: The BOM number field automatically displays the number of any active BOM for the current

item, but you can change the BOM for the production order by selecting an active BOM from the list of

approved BOM versions. The Route number field automatically displays the number of any active

Route for the current item, but you can change the Route for the production order by selecting an

active Route from the list of approved Route versions.

1. In the list, click the link in the selected row.

2. Click Edit.

3. In the Delivery field, enter a date.

4. Click Save.

5. Close the page.

Click the link for the production order number that you have just created. This will open the details

page for the order.

For example, you can change the delivery date for the production order.

1. On the Action Pane, click Production order.

2. Click BOM.

3. Click Edit.

4. In the Quantity field, enter a number.

5. Click Save.

6. Close the page.

Open the BOM page to validate the BOM data that was copied from the default data when the

production order was created. In this procedure, you need to update the quantity for a BOM.

Changing the quantity on the BOM line affects the cost estimate of material consumption for the

production order.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/create-production-order.md
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1. On the Action Pane, click Production order.

2. Click Route.

3. In the list, find and select the desired record.

4. Click Edit.

5. In the Process qty. field, enter a number.

6. Click Save.

7. Close the page.

Open the Route page to validate the data of the production route that was copied from the default

data when the order was created. In this procedure, you need to update the quantity for one of the

operations in the production route.

Changing the process time affects the estimated route consumption and the cost of the production

order.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Estimate a production order

View the calculation details

NOTENOTE

You can run this procedure by using the USMF demo data company or your own data set. In both cases, you

need to have an open production order that has the Created status. This is the second procedure out of seven

which explains the production order lifecycle.

1. Go to Production control > Production orders > All production orders.

2. Select an order that has the Created status in the grid.

3. On the Action Pane, click Production order.

4. Click Estimate.

5. Click OK.

In this step, the estimated costs of a single production order is calculated.

1. On the Action Pane, click Manage costs.

2. Click View calculation details.

This page displays the cost breakdown. For example, you can view the total cost price per unit for the

finished product in the first row. The subsequent rows contain costs according to the bill of materials,

production route, and indirect costs.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Schedule a production order

View the scheduling results

NOTENOTE

This procedure shows how to schedule a production order. The demo data company used to create this

procedure is USMF. This is the third procedure out of seven which explains the production order lifecycle.

1. Go to Production control > Production orders > All production orders.

2. On the Action Pane, click Schedule.

3. Click Schedule jobs.

4. In the Scheduling direction field, select 'Forward from today'.

5. In the Scheduling date field, enter a date.

6. Select or clear the Finite capacity check box.

7. Select or clear the Finite material check box.

8. Click OK.

Select a production order that has the Estimated status.

The parameters for scheduling are set up on this page. You can set up the parameters for specific

users or all users.

1. On the Action Pane, click Production order.

2. Click All jobs.

3. Expand or collapse the Scheduling section.

4. Click Inquiries.

5. Click Capacity load.

6. Close the page.

7. Close the page.

This page displays the scheduled jobs that you have just generated.

On the Scheduling FastTab, you can view the scheduled date and time.

The Capacity load page displays the capacity that is reserved through job scheduling, the total number

of hours that are currently reserved on the resource, and the number of hours that remain available

for job scheduling on the resource.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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This procedure shows how to release a production order. The demo data company used to create this procedure

is USMF. This is the fourth procedure out of seven which explains the production order lifecycle.

1. Go to Production control > Production orders > All production orders.

2. On the Action Pane, click Production order.

3. Click Release.

4. Click the General tab.

5. Click the Print route card checkbox.

6. Click OK.

7. Close the page.

In the grid, select a production order that has the Scheduled status.

On this page, you can confirm the release of the selected range of production orders. Click Select if

you want to add orders.

The Release step indicates when the production order is released to the production shop floor so that

the shop floor operators can report progress on the production jobs. Production papers that contain

relevant information about processing the jobs can be issued. The warehouse work for raw material

picking is generated for the items that are set up for the warehouse process.

Select which production reports should be printed. The Job card report prints a page for each

scheduled job and requires the production order to be scheduled at the job level. The report contains

information about the scheduled start and end time, the quantity to produce, and which resource

processes the job. The Route job report collects the same information on the same page, but does not

print a page for each job. The Route card report only shows the operations but not the jobs. Therefore,

this report does not require job scheduling, but can be used when production orders are scheduled at

the operation level.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Start a production order

Validate the picking list

Verify the route card journal

This procedure shows how to start a production order on the shop floor. Time and material consumption are

reported in this process. The demo data company used to create this procedure is USMF. This is the fifth

procedure out of seven which explains the production order lifecycle.

1. Go to Production control > Production orders > All production orders.

2. On the Action Pane, click Production order.

3. Click Start.

4. Click the General tab.

5. In the From Oper. No. field, enter '10'.

6. In the Automatic route consumption field, select 'Always'.

7. Click the Post route card now checkbox.

8. In the Automatic BOM consumption field, select 'Always'.

9. Click the Post picking list now checkbox.

10. Click the Print picking list checkbox.

11. Click OK.

12. Close the page.

Select a production order that has the Released status.

On this page, you can confirm the start of the production order.

This is the printed picking list that shows the materials used for the production order.

1. On the Action Pane, click View.

2. Click Picking list.

3. In the list, find and select the desired record.

4. In the list, click the link in the selected row.

5. Click Edit.

6. In the Consumption field, enter a number.

7. Click Post.

8. Click OK.

9. Click the GridPanel tab.

10. Close the page.

In the picking list journal, the materials consumed by the production order are posted. Before posting

the journal, you can make adjustments if there is a difference between the estimated quantity and the

actual consumed quantity.

1. On the Action Pane, click View.

2. Click Route card.

3. In the list, find and select the desired record.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/start-production-order.md
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4. In the list, click the link in the selected row.

5. Click Edit.

6. In the Hours field, enter a number.

7. Click Post.

8. Click OK.

In the Route card journal, the time spent on the individual operations is recorded. Good and error

quantity can also be reported.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Report a production order as finished

Verify the Report as finished journal
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This procedure shows how to report a production order as finished. The demo data company used to create this

procedure is USMF. This is the sixth procedure out of seven which explains the production order lifecycle.

1. Go to Production control > Production orders > All production orders.

2. On the Action Pane, click Production order.

3. Click Report as finished.

4. Click the General tab.

5. Set Good quantity to '18'.

6. Set Error quantity to '2'.

7. In the Error cause field, select 'Material'.

8. Select or clear the End job check box.

9. Select or clear the Accept error check box.

10. Click OK.

Select a production order that has the Started status.

On this page, you can confirm the quantity of the finished product to be reported as finished.

1. On the Action Pane, click View.

2. Click Reported as finished.

3. In the list, mark the selected row.

4. In the list, click the link in the selected row.

The Report as finished journal is posted. If you want to make adjustments to the journal, you can

manually create a new journal where you can make changes.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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End a production order

Validate calculation results

NOTENOTE

This procedure shows how to end a production order. The demo data company used to create this procedure is

USMF. This is the final procedure out of seven which explains the production order lifecycle.

1. Go to Production control > Production orders > All production orders.

2. On the Action Pane, click Production order.

3. Click End.

4. Click the General tab.

5. In the Date field, enter a date.

6. In the Scrap method field, select 'Allocation'.

7. Click OK.

Select a production order that has the status Reported as finished.

On this page, you can confirm that you want to end the production order.

When you select the Allocation method, costs from the scrapped materials are added to the finished

goods.

1. On the Action Pane, click Manage costs.

2. Click View cost comparison.

After you have ended the production order, you can compare the estimated cost price against the

realized cost price to get an overview of the production variances.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/end-production-order.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Release production orders
2/18/2021 • 2 minutes to read • Edit Online

Characteristics of the Released state

Releasing jobs to the shop floor

Route cards

Route jobs

Job cards

A released production order is an order that has been authorized for production. The term Released is used to

describe a state in the production order life cycle, where the production order is available for execution on the

production shop floor and for warehouse processes.

The ReleasedReleased state is one state in the production order life cycle. Production orders that are in the ReleasedReleased

state are available for execution on the production shop floor and for warehouse processes. The ReleasedReleased state

has the following characteristics:

A production order can be changed to the ReleasedReleased state either from the production order or by using a

batch process. The production order can also be updated automatically from planned production orders that

are firmed by using the Firming time fenceFirming time fence field on the Master planMaster plan page.

The ReleasedReleased state is the signal for the shop floor operators (operators) to start executing the production

jobs on the shop floor.

Production papers, such as route cards, route jobs, and jobs cards provide information about production jobs

and can be issued.

For materials that are physically reserved, warehouse work is generated to pick materials for the production

order.

After a production order is released, production jobs that are related to the order are visible and ready for

registration. The operators can make job registrations, such as Start, Stop, and Completion, on either the JobJob

card terminalcard terminal  page or the Job card deviceJob card device page. The registered time and quantity are automatically

transferred from the registration pages to production journals to keep track of the consumed time and quantity.

A route card provides an overview of information that comes from route and operation setups, and from

operation and job scheduling methods.

A route job lists each job of an operation in detail, and includes setup, process, queue, and transportation times.

For example, an operation such as painting might require individual jobs, such as setup time, run time for the

painting process, and queue time for drying.

A job card lists the individual job numbers of a particular operation. One job appears on each page. The jobs

that are included on a job card, and their estimated times, come from the route and operation setup information.

From a job card, you can open the Production journal linesProduction journal lines , job cardjob card page. People who run operations

resources can provide feedback about the production process. There are fields where you can enter

consumption statistics and information such as the error quantity.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/release-production-orders.md
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Work for raw material picking is generated during release. Work is generated only for the quantity of materials

that was physically reserved for the production order before the order was released. The following setup is

required to generate warehouse work for raw material picking:

A location directive for raw materials picking that determines which warehouse location to pick the materials

in

A wave template for raw materials, where policies for the execution of warehouse work are configured

A production input location that determines where materials are put

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Set a production order to Reporting as finished

NOTENOTE

Report as finished is a production stage. At this stage, a finished product is reported and moved from the

production order to the inventory.

When a quantity of the finished goods is reported as finished on a production order it is updated as on-hand in

the inventory. Partial quantities of the originally planned order quantity can be reported as finished. It is also

possible to report error quantities with an associated error reason when reporting quantities as finished. When

the production order reach the stage Reported as finished it indicates that no more quantity is going to be

reported at the production order. The following characteristics are also associated with the Repor t as finishedRepor t as finished

process:

It is possible to set up consumption of raw material and time that are proportional to the reported quantity

(back-flushing)

Put-away work can be generated for items that are enabled for warehouse processes.

The planned or standard cost value of the finished goods can be set up to be reported to ledger accounts.

A quality order can be created for the reported quantity based on the setup of a quality association.

The quantity is reported to the output location. Warehouse work is then generated to move the quantity from

the output location to its final destination defined by the location directive for the put-away work.

A quality order can be created when a production order is reported as finished if a quality association has

been set up.

You can set a production order to Repor t as finishedRepor t as finished through the standard production order update function,

or through the route and job card journals, or through the journal Repor t as finishedRepor t as finished. You can also update the

stage to Repor t as finishedRepor t as finished through the job card terminal and job card device pages, when you report on the

last job of the production order. Finally, you can enable the Repor t as finishedRepor t as finished option as a process for the

handheld warehouse device solution.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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IMPORTANTIMPORTANT

Turn on the production floor execution interface and its related
optional features

The production floor execution interfaceThe production floor execution interface

Generate license platesGenerate license plates

Print labelsPrint labels

Allow locking the touch screenAllow locking the touch screen

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

Shop floor workers use the production floor execution interface to register their daily work, such as when they

start a job, report feedback about jobs, register indirect activities, and report absence. These registrations are the

basis for tracking progress and cost on production orders, and for calculating the basis for the workers' pay.

When you open the production floor execution interface, it automatically loads a selected configuration and job

filter that are specific to the browser and device. In the configuration, you set the policies that must be applicable

for a specific usage. Here are some usage examples:

On a device in the company hall, employees clock in when they come into the office, and they clock out when

they leave for the day.

On a device on the shop floor, machine operators register when they start and complete jobs. They also

register breaks and indirect activities.

This topic describes the various options for configuring job card devices.

The production floor execution interface itself, plus several of the optional settings that are described in this

topic, must be turned on in your system before you can use them. Use the Feature management page to turn on

any or all of the features described in the following subsections as required.

This is the primary feature described in this topic. It adds the production floor execution interface to your

system. To enable it, turn on the following feature in feature management:

Production floor execution

These features make license plate functionality available to the production floor execution interface. If you'd like

to use them, turn on the following features in feature management (in this order):

1. License plate for reporting as finished added to the Job Card Device

2. Enable automatic generation of license plate number when reporting as finished in the job card device

These features make label printing functionality available to the production floor execution interface. If you'd like

to use them, turn on the following features in feature management (in this order):

1. License plate for reporting as finished added to the Job Card Device

2. Print label from Job Card Device

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/production-floor-execution-configure.md
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Asset management functionality for the production floor execution interfaceAsset management functionality for the production floor execution interface

Work with production floor execution configurations

This feature adds a button to the production floor execution interface that enables workers to sanitize the touch

screen. If you'd like to use it, turn on the following feature in feature management:

Feature for locking job card device and job card terminal so that they can be sanitized

This feature adds an asset management tab to the production floor execution interface. Workers can use this tab

to select an asset that is connected to a machine resource that is within the selected filter of the job list. For the

selected machine asset, the worker can view the state and health of the asset from counter values for up to four

selected counters. If you'd like to use this feature, turn on the following feature in feature management:

Asset management functionality for the production floor execution interface

To create and maintain device configurations, go to Production control > Setup > Manufactur ingProduction control > Setup > Manufactur ing

execution > Configure production floor executionexecution > Configure production floor execution. The Configure production floor executionConfigure production floor execution page

shows a list of existing configurations. On this page, you can perform the following actions:

Select any production floor configuration that is listed in the left column to view and edit it.

Select NewNew  on the Action Pane to add a new device configuration to the list. Then, in the ConfigurationConfiguration

field, enter a name to identify the new configuration. The name that you enter must be unique among all

device configurations, and you won't be able to edit it later.

Next, configure the various settings for the selected device configuration. The following fields are available:

Repor t quantity at clock-outRepor t quantity at clock-out – Set this option to Yes to prompt workers to report feedback about jobs

that are in progress when they clock out. When this option is set to No, workers won't be prompted.

Lock employeeLock employee – When this option is set to No, workers will be signed out immediately after they make a

registration (such as a new job). The device will then return to the sign-in page. When this option is set to Yes,

workers will stay signed in to the job card device. However, a worker can manually sign out so that another

worker can sign in while the job card device continues to run under the same system user account. For more

information about these types of accounts, see Assigned users.

Use the actual time of registrationUse the actual time of registration – Set this option to Yes to set the time for each new registration to the

exact time when the worker submitted the registration. When this option is set to No, the sign-in time is used

instead. You will usually want to set this option to Yes if you've set the Lock employeeLock employee and/or S ingleSingle

workerworker  option to Yes in cases where workers often remain signed in for longer periods.

S ingle workerSingle worker  – Set this option to Yes if only one worker uses each job card device where this configuration

is active. When this option is set to Yes, the Lock employeeLock employee option is automatically set to Yes. In addition,

this setting removes the requirement (and ability) for the worker to sign in by using a badge ID (or another

similar ID). Instead, the worker signs in to Microsoft Dynamics 365 Supply Chain Management by using a

system user account that is linked to a time registered worker (from the workers table), and gets signed in to

the job card device as that worker at the same time.

Allow locking the touchscreenAllow locking the touchscreen – Set this option to Yes to allow workers to lock the touchscreen of the job

card device so that they can sanitize it. When this option is set to Yes, a Lock screen for sanitizingLock screen for sanitizing button

is added to the device sign-in page. When a worker selects this button, the touchscreen is temporarily locked

to prevent unintended input. A countdown timer is also shown. The worker can then safely clean the device

and the screen. When the countdown is completed, the touchscreen is automatically unlocked.

Screen lock durationScreen lock duration – When the Allow locking touchscreenAllow locking touchscreen option is set to Yes, use this option to

specify the number of seconds that the touchscreen should be locked for sanitizing. The duration must be

between 5 and 120 seconds.

Generate license plateGenerate license plate – Set this option to Yes to generate a new license plate every time that a worker

uses the job card device to report as finished. The license plate number is generated from a number

sequence that is set up on the Warehouse management parametersWarehouse management parameters  page. When this option is set to No,



Clean up job configurations
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workers must specify an existing license plate when they report as finished.

Pr int labelPr int label  – Set this option to Yes to print a license plate label when a worker uses the job card device to

report as finished. The configuration of the label is set up in document routing, as described in Document

routing layout for license plate labels.

Tab selectionTab selection – Use the settings in this section to choose which tabs should be displayed by the production

floor execution interface when the current configuration is active. You can design as many tabs as you need

and then add and arrange them here as required. For details about how to design tabs and work with the

settings here, see Design the production floor execution interface.

When the shop floor supervisor sets up the production floor execution interface, they select a configuration and

a job filter. These selections are stored in a reference table in Supply Chain Management, and the browser uses

an ID that is stored in a local cookie to find the correct row in that table. The table also logs the date and time

that a worker last signed in to each device.

A batch job periodically cleans entries in the references table for devices that haven't logged any activity in the

last 60 days. You can also manually clean the entries at any time by following these steps.

1. Go to Production control > Setup > Manufactur ing execution > Configure production floorProduction control > Setup > Manufactur ing execution > Configure production floor

executionexecution.

2. On the Action Pane, select Clean up client configurationsClean up client configurations .

3. In the Clean up client configurationClean up client configuration dialog box, set the Number of daysNumber of days  field to the number of days of

inactivity (before today) to consider. You will remove all configurations and sign-in records for devices that

haven't been active during that time.

4. Select OKOK to clean up the relevant configurations, based on the Number of daysNumber of days  setting.

Can you tell us about your documentation language preferences? Take a short survey.
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IMPORTANTIMPORTANT

Design a tab

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

You can design the content of the user interface for each configuration used by the production floor execution

interface. For example, workers in one work cell might need to be able to open job instructions on the

production floor, while in another work cell, instructions are not needed. In that case, two configurations should

be created, one with a button for opening document attachments and one without this button.

On the Configure production floor executionConfigure production floor execution page, you can create and configure tabs by selecting DesignDesign

tabstabs  on the Action Pane.

Each tab is divided into four sections, as shown in the following illustration.

The following elements are shown in the illustration:

1. Primary toolbar

2. Secondary toolbar

3. Main view

4. Detailed view

To create and configure a new tab, follow these steps:

1. Go to Production control > Setup > Manufactur ing executionProduction control > Setup > Manufactur ing execution.

2. Select Design tabsDesign tabs  on the Action Pane to open the Design tabsDesign tabs  page.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/production-floor-execution-tabs.md
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Associate a tab with a configuration

3. Select NewNew  on the Action Pane.

4. Make the following settings in the header of the page:

Tab nameTab name - Specify a name for the tab.

Main viewMain view  - Select between the two pre-defined job lists (Active jobs, All jobs, or My machine).

Details viewDetails view  - Select between a blank value or Job detailsJob details . If you select the blank value, there will be

no detailed view in the tab. If you select Job detailsJob details , the detailed view will contain a detailed

description of the job selected in the job list in the main view.

5. In the Pr imar y toolbarPr imar y toolbar  section, choose which buttons should be available in the primary toolbar. The

Available actionsAvailable actions  column shows a list of all the buttons that can be added. The Selected actionsSelected actions

columns shows a list of all the buttons that are included in the current configuration. Use the buttons

between the columns to move selected items between the columns as needed. Use the up and down

buttons next to the Selected actionsSelected actions  column to control the order in which the buttons are presented in

the user interface.

6. In the Secondar ySecondar y  toolbartoolbar  section, choose which buttons should be available in the secondary toolbar.

The Available actionsAvailable actions  column shows a list of all the buttons that can be added. The Selected actionsSelected actions

columns shows a list of all the buttons that are included in the current configuration. Use the buttons

between the columns to move selected items between the columns as needed. Use the up and down

buttons next to the Selected actionsSelected actions  column to control the order in which the buttons are presented in

the user interface.

After you designed all the tabs you need, you can associate them with a configuration.

1. Go to Production control > Setup > Configure production floor executionProduction control > Setup > Configure production floor execution.
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2. On the Tab selectionTab selection FastTab, select AddAdd.

3. A new row is added to the grid. For this new row, select the name of a tab that you want to add to the

configuration.

4. Continue to add additional tabs as needed.

5. Use the Move upMove up and Move downMove down buttons on the toolbar to arrange the tabs as needed. The tabs will

be displayed from left to right in the order shown in the above screenshot (the tab at the top is shown on

the left).

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

Set the configuration and filters for a specific device

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

The production floor execution interface is set up for every device on the production floor. Companies typically

set up each device differently, depending on the purpose that the device serves. For example, a company might

have one device in the reception area, where workers clock in and clock out, and another on the shop floor,

where workers manage their jobs.

To set the configuration and job filters for a device, sign in to the Production floor executionProduction floor execution page by using

an account that has a security role that includes the Maintain time supervisor duty. (Among the out-of-box

security roles, only Shop floor supervisor has this duty.) Then follow these steps.

1. Go to the device that you want to set up, and sign in to Microsoft Dynamics 365 Supply Chain

Management as a shop floor supervisor. (Use an account that includes the Maintain time supervisor

duty.)

2. Make sure that a configuration is available for the device that you're setting up. If no configuration

already exists, a default configuration is provided. For more information about how to set up a

configuration, see Configure the production floor execution interface.

3. Go to Production control > Manufactur ing execution > Production floor executionProduction control > Manufactur ing execution > Production floor execution.

If the production floor execution interface has already been configured at least one time on the current

device, a sign-in page appears. Otherwise, a welcome page appears.

4. On either the sign-in page or the welcome page, select ConfigureConfigure.

5. Select a configuration in the list.

6. Select NextNext.

7. Select one or more filters to apply to the current device. These filters will help ensure that only relevant

jobs are shown on the device. To set a filter, select the filter type to open a list of values, and then select

the value to filter on. The following filters are available:

Production unitProduction unit – This filter is the highest-level filter. It typically refers to a large work area that has

several resource groups and individual resources in it.

Resource groupResource group – This filter is a mid-level filter. It typically refers to a collection of related resources

in a limited area of the workspace. If you select a Production unitProduction unit filter first, the list of resource

groups shows only groups from that unit. Otherwise, it shows all available resource groups.

ResourceResource – This filter is the most specific filter. It typically refers to a specific machine or other single

resource. If you select a Resource groupResource group and/or Production unitProduction unit filter first, the list of resources

shows only resources from that group and/or unit. Otherwise, it shows all available resources.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/production-floor-execution-setup.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version


Allow a worker to override the default filters

NOTENOTE

Run the interface in full-screen mode

8. Select OKOK.

9. The sign-in page appears, and your device is ready for use.

You can give specific workers permission to change the filter settings on any device that they use. For workers

who have this permission, the production floor execution interface provides a FilterFilter  button on the All jobsAll jobs  and

Active jobActive job pages.

If a worker changes a filter, the new filter applies from that point forward, for all users who sign in to the device.

To allow a worker to override the default job filters that have been set up for a device, follow these steps.

1. Go to Time and attendance > Setup > Time registration workersTime and attendance > Setup > Time registration workers .

2. Select a worker in the list to open that worker's Time registration workersTime registration workers  page.

3. On the Time registrationTime registration tab, set the Set filtersSet filters  option to Yes.

Often, you will run the production floor execution interface on a device that is used exclusively for that purpose.

Therefore, it might make sense to run the interface in full-screen mode, without showing any navigation and/or

browser chrome.

To hide the navigation pane that is shown in Supply Chain Management, add the following text to the end of

the URL in the browser's address bar : \&limitednav=true .

To also hide the browser's address bar, use the browser's native full-screen mode. (For instructions, see your

browser's documentation.)

The upper part of the following illustration shows how the interface looks by default. The lower part shows how

it looks in full-screen mode when the navigation pane is hidden.



Extend the session past 12 hours

NOTENOTE

By default, the production floor execution interface automatically signs out if nobody uses it for 12 hours. A

Supply Chain Management user must then sign in again. However, you can extend the time-out limit to up to 90

days.

To extend the time-out limit, sign in to Supply Chain Management, and go to System administration > UsersSystem administration > Users

> Session extensions> Session extensions . Specify the Supply Chain Management user account that is used to sign in to the

device, and the number of hours that the session should stay active for.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

Sign in to the production floor execution interface as a worker

All jobs tab

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

The production floor execution interface is optimized for touch interaction. Its design provides visual contrast

that meets accessibility requirements for shop floor environments. It offers all the same functional capabilities as

the job card device. However, it also enables multiple jobs to be started in parallel from a job list. (This capability

is also known as job bundling.) Additionally, from a job list, workers can open a guide that was created in

Microsoft Dynamics 365 Guide. In this way, they can get visual instructions on a HoloLens.

Before workers can start to use the device, a supervisor or technical staff must prepare it and open the correct

page in Dynamics 365 Supply Chain Management. For more information about how to set up the device, see Set

up a device to run the production floor execution interface.

After the device has been prepared, the sign-in page appears on it. This page shows information about the

status of jobs for the local work cell. This information is updated periodically. On the page, workers use their

badge IDs to sign. Although workers don't have to have a user account for Supply Chain Management, they

must have a time registered worker account that they can use when they sign in.

The remaining sections of this topic describe how workers interact with the interface.

The All jobsAll jobs  tab provides a job list that shows all the production jobs that have a status of Not started, Stopped,

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/production-floor-execution-use.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version


Active jobs tab

or Started. (This tab name is customizable and may be different for your system.)

The job list has the following columns. The numbers correspond to the numbers in the previous illustration.

1. Selection columnSelection column – The leftmost column uses check marks to indicate jobs that have been selected by the

worker. Workers can select multiple jobs in the list at the same time. To select all the jobs in the list, select the

check mark in the column header. When a single job is selected, details about that job are shown in the lower

part of the page.

2. Job status columnJob status column – This column uses symbols to indicate the status of each job. Jobs that have no symbol

in this column have a status of Not started. A green triangle indicates jobs that have a status of Started. Two

yellow vertical lines indicate jobs that have a status of Stopped.

3. High pr ior ity columnHigh prior ity column – This column uses exclamation marks to indicate jobs that have high priority.

4. OrderOrder  – This column shows the production order number for a job.

5. Descr iptionDescr iption – This column shows a description of the operation that a job is part of.

6. RequestedRequested – This column shows the quantity that a job is planned to produce.

7. Star tedStar ted – This column shows the quantity that has already been started for a job.

8. CompletedCompleted – This column shows the quantity that has already been completed for a job.

9. ScrappedScrapped – This column shows the quantity that has already been scrapped for a job.

10. RemainingRemaining – This column shows the quantity that remains to be completed for a job.

The Active jobsActive jobs  tabs shows a list of all jobs that the signed-in worker has already started. (This tab name is

customizable and may be different for your system.)



My machine tab

The active jobs list has the following columns:

Selection columnSelection column – The leftmost column uses check marks to indicate jobs that have been selected by the

worker. Workers can select multiple jobs in the list at the same time. To select all the jobs in the list, select the

check mark in the column header. When a single job is selected, details about that job are shown in the lower

part of the page.

OrderOrder  – This column shows the production order number for a job.

Descr iptionDescr iption – This column shows a description of the operation that a job is part of.

RequestedRequested – This column shows the quantity that a job is planned to produce.

Star tedStar ted – This column shows the quantity that has already been started for a job.

CompletedCompleted – This column shows the quantity that has already been completed for a job.

ScrappedScrapped – This column shows the quantity that has already been scrapped for a job.

RemainingRemaining – This column shows the quantity that remains to be completed for a job.

The My machineMy machine tab lets workers select an asset that is connected to a machine resource within the filter set on

the All jobsAll jobs  tab. The worker can then view the state and health of the selected asset by reading values for up to

four selected counters and lists of recent maintenance requests and registered downtimes. The worker can also

request maintenance for the selected asset and register and edit machine downtime. (This tab name is

customizable and may be different for your system.)



The My machineMy machine tab has the following columns. The numbers correspond to the numbers in the previous

illustration.

NOTENOTE

1. Machine assetMachine asset – Select the machine asset that you want to track. Start typing a name to select from a

list of matching assets, or select the magnifying-glass icon to select from a list of all assets associated

with the resources that are within the filter of the job list.

Supply Chain Management users can assign a resource to each asset as needed using the All assetsAll assets  page (on

the Fixed assetFixed asset  tab, using the ResourceResource drop-down list). For more information, see Create an asset.

2. SettingsSettings  – Select the gear icon to open a dialog box where you can choose which counters to view for

the selected machine asset. Values for these counters are shown at the top of the Asset managementAsset management

tab. The SettingsSettings  menu (shown in the following screenshot) lets you enable up to four counters. For each

counter that you want to enable, use the lookup field at the top of the tile to select a counter. The lookup

field lists all of the counters associated to the asset selected at the top of the Asset managementAsset management page.

Set each counter to monitor either the AggregatedAggregated value or the latest ActualActual  value for the counter. For

example, if you set a counter that tracks how many hours the machine has been running, then you should

set it to AggregatedAggregated. If you set a counter to measure the latest updated temperature or pressure, then

you should set it to ActualActual . Select OKOK to save your settings and close the dialog box.



Starting and completing production jobs

Reporting good quantities

3. Request maintenanceRequest maintenance – Select this button to open a dialog box where you can create a maintenance

request. You'll be able to provide description and a note. The request will be brought to the attention of a

Supply Chain Management user, who will then be able to convert the maintenance request to a

maintenance work order.

4. Register downtimeRegister downtime – Select this button to open a dialog box where you can register machine

downtime. You'll be able to select a reason code and enter a date/time span for the downtime. The

machine downtime registration is used for calculating the efficiency of the machine asset.

5. View or editView or edit – Select this button to open a dialog box where you can edit or view existing downtime

records.

Workers start a production job by selecting a job on the All jobsAll jobs  tab and then selecting Star t jobStar t job to open the

Star t jobStar t job dialog box.

Workers use the Star t jobStar t job dialog box to confirm the production quantity and then start the job. Workers can

adjust the quantity by selecting the QuantityQuantity  field and then using the numeric keyboard that appears. Workers

then select Star tStar t to start to work on the job. The Star t jobStar t job dialog box is closed, and the job is added to the

Active jobsActive jobs  tab.

Workers can start a job that is in any status. When a worker starts a job that has a status of Not started, the

QuantityQuantity  field in the Star t jobStar t job dialog box initially shows the full quantity. When a worker starts a job that has a

status of Started or Stopped, the QuantityQuantity  field initially shows the remaining quantity.

When a worker completes or partially completes a job, they can report good quantities that were produced by

selecting a job on the Active jobsActive jobs  tab and then selecting Repor t progressRepor t progress . Then, in the Repor t progressRepor t progress

dialog box, the worker enters the good quantity by using the numeric keyboard. The quantity is blank by default.

After a quantity is entered, the worker can update the status of the job to In progress, Stopped, or Completed.



Reporting scrap

Completing a job and starting a new job

When a worker completes or partially completes a job, they can report scrap by selecting a job on the ActiveActive

jobsjobs  tab and then selecting Repor t scrapRepor t scrap. Then, in the Repor t scrapRepor t scrap dialog box, the worker enters the scrap

quantity by using the numeric keyboard. The worker also selects a reason (None, Machine, Operator, or

Material).

Usually, workers complete a job by selecting one or more current jobs on the Active jobsActive jobs  tab and then

selecting Repor t progressRepor t progress . They then enter the quantity that was produced (the good quantity) and set the

status to Complete. If more than one job was selected, a worker then uses the PreviousPrevious  and NextNext buttons to

move among them. To start a new job, the worker selects it on the All jobsAll jobs  tab and then selects Star t jobStar t job.

A worker can also start a new job while their previous job is still open. Once again, the worker selects the new

job on the All jobsAll jobs  tab and then selects Star t jobStar t job. However, in this case, the Star t jobStar t job dialog box informs the

worker that they are currently working on a job, and that they must therefore either stop or complete that job

before they start the new job.



Working on multiple jobs in parallel

Scenario 1: A worker who has no active jobs wants to start two jobs and work on them in parallelScenario 1: A worker who has no active jobs wants to start two jobs and work on them in parallel

Scenario 2: A worker who has two active jobs that are in progress wants to start a third job and work on it inScenario 2: A worker who has two active jobs that are in progress wants to start a third job and work on it in
parallel with the other twoparallel with the other two

Working on indirect activities

Registering breaks

Opening instructions

Opening mixed-reality guides for HoloLens

One worker can work on multiple jobs at the same time (that is, in parallel). In this case, the collection of jobs

that the worker is working on is called a job bundle. The worker can add new jobs to the bundle, or complete

one or more jobs in the bundle. The following two scenarios show how a worker can work on jobs in parallel.

The worker selects the two jobs on the All jobsAll jobs  tab and then selects Star t jobStar t job. The Star t jobStar t job dialog box shows

both selected jobs, and the worker can adjust the quantity to start on each job. The worker then confirms the

dialog box and can start both jobs.

The worker selects the third job on the All jobsAll jobs  tab and then selects BundleBundle. In the BundleBundle dialog box, the

worker can adjust the quantity to start. The worker then confirms the dialog box by selecting BundleBundle.

Indirect activities are activities that aren't directly related to a production order. Indirect activities can be flexibly

defined, as described in Set up indirect activities for time and attendance.

For example, Shannon, a floor worker at Contoso, wants to attend a company meeting, and meetings are

considered an indirect activity. One of the following two scenarios applies:

Shannon is working on one or more active jobs.Shannon is working on one or more active jobs. Shannon selects ActivityActivity , identifies the activity

(meeting), and confirms her selection. A message that appears informs her that she has jobs that are in

progress. From the message, Shannon can choose to complete or stop the jobs that she is working on before

she goes to the meeting.

Shannon doesn't have any active jobs.Shannon doesn't have any active jobs. Shannon selects ActivityActivity , identifies the activity (meeting), and

she confirms her selection. She is now registered as being at the meeting.

In both scenarios, after Shannon confirms her selection, she goes to either the sign-in page or a page that will

wait for her to confirm that she has returned from her indirect activity. The page that appears depends on the

configuration of the production floor execution interface. (For more information, see Configure the production

floor execution interface.)

Workers can register breaks. Breaks can be flexibly defined, as described in Pay based on registrations.

A worker registers a break by selecting BreakBreak and then selecting the card that represents the break type (such

as lunch). After the worker confirms the selection, the device shows either the sign-in page or a page that will

wait for the worker to confirm that they have returned from the break. The page that appears depends on the

configuration of the production floor execution interface. (For more information, see Configure the production

floor execution interface.)

Workers can open a document that is attached to a job by selecting InstructionsInstructions . The InstructionsInstructions  button is

available only if a document is associated with the job in the master data. For example, a document that is

attached to a product on the Released productsReleased products  page in Supply Chain Management will be available for

workers to open in the shop floor execution interface.

https://docs.microsoft.com/en-us/dynamicsax-2012/appuser-itpro/set-up-indirect-activities-for-time-and-attendance


NOTENOTE

Dynamics 365 Guides can help empower workers by providing hands-on learning that uses mixed reality. You

can define standardized processes where step-by-step instructions guide workers to the tools and parts that

they need and show how to use those tools in real work situations. Here is an overview of the process.

1. Every time that a worker opens a job list in the shop floor execution interface, the interface finds all relevant

guides for the jobs that are shown.

2. The worker selects GuidesGuides  to view the list of guides.

3. The worker selects a relevant guide in the list.

4. The shop floor execution interface shows a QR code for the selected guide.

5. The worker puts on a HoloLens and glances at the QR code to start the guide.

6. The worker works through the guide to learn the task.

For more information about how to create, assign, and use guides for HoloLens, see Provide mixed-reality

Guides for workers in production.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://dynamics.microsoft.com/mixed-reality/guides/
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Enable new features in feature management

Generate license plateGenerate license plate

Print labelPrint label

Allow locking of touch screenAllow locking of touch screen

Manage your device configurations

General settings

The job card device is used by the shop floor workers to register their daily work, such as when jobs are started,

reporting feedback on jobs, registering indirect activities, and reporting absence. These registrations are the

basis for tracking progress and cost on production orders and for calculating the basis for the workers' pay. This

topic describes the various options for configuring job card devices.

A few of the settings described in this topic must be enabled on your system before they will be available to you.

Use the feature management page to enable any or all of the following features as required.

To make this feature available, enable the following features in feature management (in order):

1. License plate for reporting as finished added to the Job Card Device

2. Enable automatic generation of license plate number when reporting as finished in the job card device

To make this feature available, enable the following features in feature management (in order):

1. License plate for reporting as finished added to the Job Card Device

2. Print label from Job Card Device

To make this feature available, enable the following feature in feature management:

(Preview) Feature for locking job card device and job card terminal so that they can be sanitized

To set up your device configurations, go to Production control > Setup > Manufactur ing execution >Production control > Setup > Manufactur ing execution >

Configure job card for devicesConfigure job card for devices . The Configure job card for devicesConfigure job card for devices  page opens, which shows a list of

existing configurations. From here, you can do the following:

Select any device configuration listed in the left column to view and edit it.

Select NewNew  on the Action Pane to add a new device configuration to the list. Then enter a name in the

ConfigurationConfiguration field to identify the new configuration. The value you enter here must be unique among all

device configurations, and you won't be able to edit it later.

Refer to following sections for details about each of the settings for configuring job card devices.

The GeneralGeneral  FastTab lets you configure each of the various options available for the selected device

configuration. The following settings are available:

Repor t quantity at clock-outRepor t quantity at clock-out - Set this to YesYes  to prompt workers to report feedback on jobs in progress

when clocking out. When set to NoNo, workers won't not be prompted.

Lock employeeLock employee - When this option is set to NoNo, each worker will be logged out immediately after they

make a registration (such as a new job), and then the device will return to the log-in page. When this option

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/config-job-card-device.md


Assigned users

is set to YesYes , each worker will stay logged in to the job card device. However, the worker will still be able to

log out manually to allow another worker to log in while the job card device remains running under the

same system user account. For more information about these types of accounts, see Assigned users.

Barcode scannerBarcode scanner  - Set this to YesYes  to provide an option on the job card device that allows workers register

the start of a new job by scanning a bar code.

Use the actual time of registrationUse the actual time of registration - Set this to YesYes  to set the time for each new registration to be equal

to the exact time that registration was submitted by a worker. Set to NoNo to use the log-in time instead. You'll

usually want to set this to YesYes  if you have enabled the Lock employeeLock employee and/or S ingle workerSingle worker  options,

where workers often remain logged in for longer periods.

S ingle workerSingle worker  - Set this option to YesYes  if only one worker uses each job card device where this configuration

is active. When this option is selected, the Lock employeeLock employee option is automatically set to YesYes . In addition, this

option removes the requirement (and ability) for the worker to log in using a badge ID (or similar). Instead

the worker signs in to Supply Chain Management using a system user account linked to a time registered

worker (from the workers table) and gets logged in to the job card device as that worker at the same time.

For more information about these types of accounts, see Assigned users.

Allow workers to set personal filtersAllow workers to set personal filters  - Set this option to YesYes  to allow workers to filter the jobs shown to

them on the device. The worker can modify values for any of the three filter criteria: Production unitProduction unit,

Resource groupResource group and ResourceResource. Only jobs that are scheduled on resources matching the selected filter

criteria will be shown on the device. You can also assign default values for any or all of these criteria, and

those will apply even with this option is not selected.

Allow locking the touchscreenAllow locking the touchscreen - Set this option to YesYes  to allow workers to lock the job card device

touchscreen so they can sanitize it. When enabled, a Lock screen for sanitizingLock screen for sanitizing button is added to the

device log-in page. When a worker selects this button, the touchscreen temporarily locks to prevent

unintended input and a countdown timer is shown. The worker can now safely clean the device and the

screen. When the countdown completes, the touchscreen automatically unlocks again.

Screen lock durationScreen lock duration - When the Allow locking touchscreenAllow locking touchscreen option is enabled, use this option so

specify number of seconds the touchscreen should be locked for sanitizing. The duration must be between 5

and 120 seconds.

Production unitProduction unit - Select a production unit to be applied as a default filter criterion for the list of jobs shown

to each worker. Only jobs that are scheduled on resources grouped under the selected production unit will

initially be displayed by the device. If Allow workers to set personal filtersAllow workers to set personal filters  is enabled, workers will be

able to edit this value, otherwise this filter will always apply when this device configuration is active.

Resource groupResource group - Select a resource group to be applied as a default filter criterion for the list of jobs shown

to each worker. Only jobs that are scheduled on resources grouped under the selected resource group will

initially be displayed by the device. If Allow workers to set personal filtersAllow workers to set personal filters  is enabled, workers will be

able to edit this value, otherwise this filter will always apply when this device configuration is active.

ResourceResource - Select a resource to be applied as a default filter criterion for the list of jobs shown to each

worker. Only jobs that are scheduled on the selected resource will initially be displayed by the device. If

Allow workers to set personal filtersAllow workers to set personal filters  is enabled, workers will be able to edit this value, otherwise this

filter will always apply when this device configuration is active.

Generate license plateGenerate license plate - Set this option to YesYes  to generate a new license plate each time a worker uses the

job card device to report as finished. The license plate number is generated from a number sequence set up

on the Warehouse management parametersWarehouse management parameters  page. When set to NoNo, workers must specify an existing

license plate when reporting as finished.

Pr int labelPr int label  - Set this option to YesYes  to print a license plate label when a worker uses the job card device to

report as finished. The configuration of the label is set up in document routing, as described in Document

routing layout for license plate labels.

    

Use the Assigned usersAssigned users  FastTab to associate one or more system users with the current device configuration.



Additional resources

NOTENOTE

Each system user can only be assigned one job device configuration.

When setting up a device, an IT worker typically signs in to Supply Chain Management using a system user

account. Thereafter, the job device configuration associated with that system user applies for as long as that

system user remains signed in. These system user accounts are typically limited to allow access only to the job

card device page and no other part of Supply Chain Management.

After the system user is signed in and the job device configuration is loaded, workers can then log in to the job

card device using their time registered worker account (for example, by scanning a bar code on their badge) so

they can start new jobs and make other kinds of registrations. Various workers can log in and out during the

day, while the same device configuration remains in effect on that machine because the system user remains

signed in to Supply Chain Management for the day.

However, as mentioned previously, when you use a device configuration with the S ingle workerSingle worker  option,

workers themselves typically sign in to Supply Chain Management using a system user linked to their own time

registered worker account, so they load the device configuration and log in as a worker on the job card device at

the same time.

Report as finished from the job card device

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Control whether quantities that are reported as finished are added to
inventory

NOTENOTE

Report batch-controlled items as finished

Workers use the Repor t progressRepor t progress  page on the job card device to report quantities that have been completed

for a production job. This topic describes how to set up various options that establish how workers can report as

finished using this page and what happens next. Options include:

Control whether and how quantities that are reported as finished are added to inventory.

Control whether and how batch numbers are generated and applied when reporting as finished.

Control whether and how serial numbers are generated and applied when reporting as finished.

Control whether and how to report as finished to a license plate.

To control whether and how the quantities that are reported as finished on the last operation should be added to

inventory, follow these steps.

1. Go to Product control > Setup > Manufactur ing execution > Production order defaultsProduct control > Setup > Manufactur ing execution > Production order defaults .

2. On the Repor t as finishedRepor t as finished tab, set the Update finished repor t on-lineUpdate finished repor t on-line field to one of the following

values:

NoNo – No quantity will be added to inventory when quantities are reported on the last operation. The

status of the production order will never change.

Status + QuantityStatus + Quantity  – The status of the production order will change to Reported as finished, and the

quantity will be reported as finished to inventory.

QuantityQuantity  – The quantity will be reported as finished to inventory, but the status of the production

order will never change.

StatusStatus  – Only the status of the production order will change. No quantities will be added to inventory

when quantities are reported on the last operation.

Quantities aren't tracked in inventory if the operations that they are reported as finished on aren't defined as the last

operation. However, those quantities can be used to view progress. They can also be included in rules that control

whether workers can start the next operation before a defined threshold of reported quantities on the previous operation

is reached. You can define these rules on the Quantity validationQuantity validation tab on the Production order defaultsProduction order defaults  page.

For more information about how to work with the Production order defaultsProduction order defaults  page, see Production

parameters in Manufacturing execution.

The job card device supports three scenarios for reporting on batch items. These scenarios apply both to items

that are enabled for advanced warehouse processes and to items that aren't enabled for advanced warehouse

processes.

Manually assigned batch numbersManually assigned batch numbers  - Workers enter a custom batch number. This batch number might

come from an external source that isn't known to the system.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/report-finished-job-device.md


Enable the feature on your systemEnable the feature on your system

Configure products that require batch number reportingConfigure products that require batch number reporting

NOTENOTE

Set up a tracking number group that lets workers manually assign a batch numberSet up a tracking number group that lets workers manually assign a batch number

Predefined batch numbersPredefined batch numbers  - Workers select a batch number in a list of batch numbers that the system

automatically generates before the production order is released to the job card device.

Fixed batch numbersFixed batch numbers  - Workers don't enter or select a batch number. Instead, the system automatically

assigns a batch number to the production order before it's released.

To enable your job card devices to accept a batch number during reporting as finished, you must use feature

management to turn on the following features (in this order):

1. Improved user experience for the Report progress dialog in the Job Card Device

2. Enable to enter batch and serial numbers while reporting as finished from the Job Card Device (Preview)

To enable a product to support any of the available batch-controlled scenarios, follow these steps:

1. Go to Product information management > Products > Released productsProduct information management > Products > Released products .

2. Select the product to configure.

3. On the Manage inventor yManage inventor y  FastTab, in the Batch number groupBatch number group field, select the tracking number group

that is set up to support your scenario.

By default, if no batch number group is assigned to a batch-controlled product, the job card device provides manual entry

for the batch number during reporting as finished.

The following sections describe how to set up tracking number groups to support each of the three scenarios

for reporting on batch items.

To allow for manually assigned batch numbers, follow these steps to set up a tracking number group.

1. Go to Inventor y management > Setup > Dimensions > Tracking number groupsInventor y management > Setup > Dimensions > Tracking number groups .

2. Create or select the tracking number group to set up.

3. On the GeneralGeneral  FastTab, set the ManualManual  option to YesYes .

4. Set other values as you require, and then select this tracking number group as the batch number group



Set up a tracking number group that provides a list of predefined batch numbersSet up a tracking number group that provides a list of predefined batch numbers

for released products that you want to use this scenario for.

When you use this scenario, the Batch numberBatch number  field that the Repor t progressRepor t progress  page on the job card device

provides is a text box where workers can enter any value.

To provide a list of predefined batch numbers, follow these steps to set up a tracking number group.

1. Go to Inventor y management > Setup > Dimensions > Tracking number groupsInventor y management > Setup > Dimensions > Tracking number groups .

2. Create or select the tracking number group to set up.

3. On the GeneralGeneral  FastTab, set the Only for inventor y transactionsOnly for inventor y transactions  option to YesYes .

4. Use the Per qtyPer qty  field to split batch numbers per quantity, based on the value that you enter. For example,

you have a production order for ten pieces, and the Per qtyPer qty  field is set to 2. In this case, five batch

numbers will be assigned to the production order when it's created.

5. Set other values as you require, and then select this tracking number group as the batch number group

for released products that you want to use this scenario for.

When you use this scenario, the Batch numberBatch number  field that the Repor t progressRepor t progress  page on the job card device

provides is a drop-down list where workers must select a predefined value.



Set up a tracking number group that automatically assigns batch numbersSet up a tracking number group that automatically assigns batch numbers
If batch numbers should be assigned automatically, without worker input, follow these steps to set up a tracking

number group.

1. Go to Inventor y management > Setup > Dimensions > Tracking number groupsInventor y management > Setup > Dimensions > Tracking number groups .

2. Create or select the tracking number group to set up.

3. On the GeneralGeneral  FastTab, set the Only for inventor y transactionsOnly for inventor y transactions  option to NoNo.

4. Set the ManualManual  option to NoNo.

5. Set other values as you require, and then select this tracking number group as the batch number group

for released products that you want to use this scenario for.

When you use this scenario, the Batch numberBatch number  field that the Repor t progressRepor t progress  page on the job card device

provides shows a value, but workers can't edit it.



Report serial-controlled items as finished

Enable the feature on your systemEnable the feature on your system

Configure products that require serial-number reportingConfigure products that require serial-number reporting

NOTENOTE

Set up a tracking number group that lets workers manually assign a serial numberSet up a tracking number group that lets workers manually assign a serial number

The job card device supports three scenarios for reporting on serial-controlled items. These scenarios apply

both to items that are enabled for advanced warehouse processes and to items that aren't enabled for advanced

warehouse processes.

Manually assigned ser ial numbersManually assigned ser ial numbers  - Workers enter a custom serial number. This serial number might

come from an external source that isn't known to the system.

Predefined ser ial numbersPredefined ser ial numbers  - Workers select a serial number in a list of serial numbers that the system

automatically generates before the production order is released to the job card device.

Fixed ser ial numberFixed ser ial number  - Workers don't enter or select a serial number. Instead, the system automatically

assigns a serial number to the production order before it's released.

To enable your job card devices to accept a serial number during reporting as finished, you must use feature

management to turn on the following features (in this order):

1. Improved user experience for the Report progress dialog in the Job Card Device

2. Enable to enter batch and serial numbers while reporting as finished from the Job Card Device (Preview)

To enable a product to support any of the available serial-controlled scenarios, follow these steps:

To enable each scenario, follow these steps.

1. Go to Product information management > Products > Released productsProduct information management > Products > Released products .

2. Select the product to configure.

3. On the Manage inventor yManage inventor y  FastTab, in the Ser ial number groupSerial number group field, select the tracking number group

that is set up to support your scenario.

By default, if no serial number group is assigned to a serial-controlled product, the job card device provides manual entry

for the serial number during reporting as finished.

The following sections describe how to set up tracking number groups to support each of the three scenarios

for reporting on serial-controlled items.



Set up a tracking number group that provides a list of predefined serial numbersSet up a tracking number group that provides a list of predefined serial numbers

To allow for manually assigned serial numbers, follow these steps to set up a tracking number group.

1. Go to Inventor y management > Setup > Dimensions > Tracking number groupsInventor y management > Setup > Dimensions > Tracking number groups .

2. Create or select the tracking number group to set up.

3. On the GeneralGeneral  FastTab, set the ManualManual  option to YesYes .

4. Set other values as you require, and then select this tracking number group as the serial number group

for released products that you want to use this scenario for.

When you use this scenario, the Ser ial numberSerial number  field that the Repor t progressRepor t progress  page on the job card device

provides is a text box where workers can enter any value for the serial number. On entering a value, it is added

to the serial number list. In this list, workers can do the following:

To mark a serial number as scrapped, select the ScrapScrap button for the appropriate row. The worker will be

prompted to provide an Error causeError cause.

To delete a serial number, select the DeleteDelete button for the appropriate row.

To provide a list of predefined serial numbers, follow these steps to set up a tracking number group.

1. Go to Inventor y management > Setup > Dimensions > Tracking number groupsInventor y management > Setup > Dimensions > Tracking number groups .

2. Create or select the tracking number group to set up.

3. On the GeneralGeneral  FastTab, set the Only for inventor y transactionsOnly for inventor y transactions  option to YesYes .



Set up a tracking number group that automatically assigns serial numbersSet up a tracking number group that automatically assigns serial numbers

4. Use the Per qtyPer qty  field to split serial numbers per quantity of one.

5. Set other values as you require, and then select this tracking number group as the serial number group

for released products that you want to use this scenario for.

When you use this scenario, the Ser ial numberSerial number  field that the Repor t progressRepor t progress  page on the job card device

provides is a drop-down list where workers must select a predefined value.

If a serial number should be assigned automatically, without worker input, follow these steps to set up a tracking

number group.

1. Go to Inventor y management > Setup > Dimensions > Tracking number groupsInventor y management > Setup > Dimensions > Tracking number groups .

2. Create or select the tracking number group to set up.

3. On the GeneralGeneral  FastTab, set the Only for inventor y transactionsOnly for inventor y transactions  option to NoNo.

4. Set the ManualManual  option to NoNo.



Report as finished to a license plate

Enable license plate reporting and label printingEnable license plate reporting and label printing

Set up reporting as finished to a license plateSet up reporting as finished to a license plate

5. Set other values as you require, and then select this tracking number group as the serial number group

for released products that you want to use this scenario for.

When you use this scenario, the Ser ial numberSerial number  field that the Repor t progressRepor t progress  page on the job card device

provides shows a value, but workers can't edit it. This scenario is only relevant when a production order is

created for a quantity of one piece of a serial number-controlled item.

Advanced warehouse processes can use the license plate dimension to track inventory on warehouse locations

that have been set up for this purpose. In this case, the license plate number is required when a worker reports

quantities as finished.

To use the features that are described in this section, you must use feature management to turn on the following

features (in this order):

1. License plate for reporting as finished added to the Job Card Device

2. Enable automatic generation of license plate number when reporting as finished in the job card device

3. Print label from Job Card Device

To control whether workers should reuse an existing license plate or generate a new license plate when they

report quantities as finished, follow these steps.

1. Go to Production control > Setup > Manufactur ing execution > Configure job card forProduction control > Setup > Manufactur ing execution > Configure job card for

devicesdevices .



NOTENOTE
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2. Set the following options for each device:

Generate license plateGenerate license plate – Set this option to YesYes  to generate a new license plate for each report as

finished. Set it to NoNo if an existing license plate should be used for each report as finished.

Pr int labelPr int label  – Set this option to YesYes  if the worker must print a license plate label for each report as

finished. Set it to NoNo if no label is required.

To configure the label, go to Warehouse management > Setup > Document routing > Document routingWarehouse management > Setup > Document routing > Document routing. For

more information, see Enable license plate label printing.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Effective November 2020:

Common Data Service has been renamed to Microsoft Dataverse. For more information, see Power Automate Blog.

Some terminology in Microsoft Dataverse has been updated. For example, entity is now table and field is now column.

For more information, see Terminology updates.

This topic will be updated soon to reflect the latest terminology.

Workers in production processes will benefit from relevant instructions that are provided at the right time in the

context of their work. Instructions apply in several domains of work, including: assembly, service, operations,

certification, and safety. Across all of these core business functions, ongoing training instructions can help

empower workers to achieve more and work better.

You can provide instructions in different ways. One efficient system that ships out of the box uses Dynamics 365

Guides.

Dynamics 365 Guides can help empower your employees with hands-on learning. You can define standardized

processes with step-by-step instructions that guide your employees to the tools and parts they need and show

employees how to use these tools in real work situations.

You can attach guides to various aspects of production control including:

Resources

Resource groups

Released products

Formulas

Formula versions

Bills of material (BOMs)

BOM versions

Routes

Route versions

Route operation relations

You can also attach Guides with Asset Management. For more information about that option, see Integrate Dynamics 365

Supply Chain Management (Asset Management) with Dynamics 365 Guides.

When a first-line worker chooses a job on the shop floor through Supply Chain Management, the worker can

see the relevant guides on the job card. When the worker chooses a specific guide, a QR code for that guide is

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/instruction-guides-in-production-overview.md
https://aka.ms/PAuAppBlog
https://go.microsoft.com/fwlink/?linkid=2147247
https://dynamics.microsoft.com/mixed-reality/guides/


AssemblyAssembly

ServiceService

QualityQuality

shown on the screen. The worker then uses their HoloLens to scan the QR code, which launches Guides and

shows the required instructions.

The following subsections describe a few selected scenarios where companies across industries can see the

biggest value when using Guides to present instructions for manufacturing.

Instructions in assembly operations show workers the tools and parts they need and how to use them in real

work situations.

Production managers can create and assign Guides, for example, for production routes, operation relations, or

bills of material. Workers will find the relevant instructions on the respective operation experience on the shop

floor.

Equip technicians with guided instructions at the job site, eliminating the need to schedule additional visits.

Service managers can assign Guides, for example, to specific products that walk through routines of quality

assessment.

Rollout new processes and ensure increased consistency by turning employee knowledge into a repeatable tool.

Quality assurance managers can assign guides, for example, to products that walk through routines of quality

assessment.

https://docs.microsoft.com/en-us/dynamics365/commerce/product
https://docs.microsoft.com/en-us/dynamics365/commerce/product


CertificationsCertifications

SafetySafety

Get started with instructions and Guides

PrerequisitesPrerequisites

Turn on the featureTurn on the feature

Configure how Guides appear on the shop floor

Ensure every employee meets high standards by quickly identifying who needs help and where.

Provide instructions that walk through dangerous procedures virtually before attempting in the physical

environment. With a mixed reality approach, workers can experience dangerous procedures virtually.

Production managers can provide dedicated handling instructions for hazardous material handling or delicate

handling procedures by assigning instructions to product items, routes, and operations.

To enable instructions in production processes, Supply Chain Management provides an out-of-the-box

integration with Dynamics 365 Guides. A licensed and installed application instance of Guides is required to

build, maintain, and assign mixed reality instructions to production assets and work.

To use this feature, your system must include the following:

Dynamics 365 Supply Chain Management version 10.0.15 or later

Dual-write for Supply Chain Management apps.

Dynamics 365 Guides version 400.0.1.48 or later

To make the feature available on your system, you must enable its configuration keys. You only need to do this

once. To do this, an administrator must do the following:

1. Place your system into maintenance mode as described in Maintenance mode.

2. Go to System administration > Setup > L icense configurationSystem administration > Setup > L icense configuration.

3. Expand the Mixed realityMixed reality  section and then select the Mixed reality guideMixed reality guide check box.

4. Expand the Production managementProduction management section and then select the Production instructionsProduction instructions  check box.

5. Turn off maintenance mode as described in Maintenance mode.

https://docs.microsoft.com/en-us/dynamics365/commerce/product
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/dual-write/enable-dual-write
https://docs.microsoft.com/en-us/dynamics365/mixed-reality/guides/setup#step-2-create-a-common-data-service-environment-and-install-the-dynamics-365-guides-solution
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/sysadmin/maintenance-mode
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/sysadmin/maintenance-mode
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Get an overview of all Guide assignments

To configure how Guides appear on the shop floor, go to Mixed Reality > Dynamics 365 Guides >Mixed Reality > Dynamics 365 Guides >

Configure Guides integrationConfigure Guides integration.

Set the following fields:

Microsoft Dataverse URLMicrosoft Dataverse URL  - Specify the URL for the Microsoft Dataverse environment where you create

your Guides. The format is "contoso.crm4.dynamics.com", where the first part of the URL is typically named

after your organization (such as "contoso."), the second part is specific to the data region of your

environment (such as "crm4."), and the last part is the domain (such as "dynamics.com"). One way to find the

right URL is to go to home.dynamics.com and then open your Guides app. When Guides opens, you will see

the URL in the address bar of your browser (only take the base URL, which should resemble the previous

example). This value is used to compose addresses for your guides and will be encoded into the QR codes."

QR code sizeQR code size - Set the size of the rendered QR code. We recommend choosing a size that will fill most of

your display screen, but not more. Typically, 15 is a good value.

QR code error correction levelQR code error correction level  - Set the granularity of the QR code. Higher granularity can help increase

the code's reliability, but your QR code sizeQR code size must be large enough to support the level of detail required by

your selected correction level.

QR codes sizes that are too large for your display will take a bit longer to render and then be scaled down to fit your

display. These do not provide a benefit.

QR code sizes that are too small may decrease the ability of HoloLens to read the code properly in some

environments.

We recommend that you test the settings for each device that will display QR codes for HoloLens users. Choose

settings that provide sufficient readability in your shop floor environment.

Use the All GuidesAll Guides  page to see the list of all available Guides in your organization and all assignments to your

production processes and resources. To open it, go to Mixed reality > Guides > All GuidesMixed reality > Guides > All Guides . The list at the

top shows all the available Guides and you can use the field here to filter the list. The list at the bottom shows all

Guide assignments and provides a toolbar for managing them.

https://home.dynamics.com/


  Associate a Guide to a resource

Typical scenario using resourcesTypical scenario using resources

Add a Guide to a resourceAdd a Guide to a resource

The following sections describe the types of objects that you can assign Guides to. Each assigned guide provides

instructions that are automatically attached to the respective production jobs and will be available on the shop

floor.

Add a Guide to a resource to offer the Guide in the context of relevant production jobs.

For example, you could attach a Guide with general machine security or handling instructions to a resource of

type machine. Then, the Guide will be available on every job that is performed on the machine.

To add a Guide to a resource:

1. Go to Production control > Setup > Resources > ResourcesProduction control > Setup > Resources > Resources .

2. From the list pane, select the resource you want to assign a Guide to.

3. Expand the Associated GuidesAssociated Guides  FastTab.

4. Select AddAdd from the Associated GuidesAssociated Guides  toolbar. A new line is added to the grid.

5. For the new line, use the drop-down list in the NameName column to choose the Guide you want to assign. If you

have a large number of Guides, then you can filter the list to find the one you are looking for. 



  

  

Associate a Guide to a resource group

Typical scenarios using resource groupsTypical scenarios using resource groups

Add a Guide to a resource groupAdd a Guide to a resource group

Associate a Guide to a released product

Typical scenario using released productsTypical scenario using released products

Add a Guide to a released productAdd a Guide to a released product

You can add a guide to resource groups if you use them to manage groups of machines, production lines, or

work cells.

Example 1:Example 1: You have defined a resource group for several machines of the same model. Instead of assigning

the relevant handling instruction guide for the machine model to every relevant resource, you could instead

assign the Guide to the resource group that reflects that machine model.

Example 2:Example 2: You have defined a resource group for a work cell that contains different machines and you have a

Guide that provides general instructions for how to maintain the work cell. The Guide applies to any production

activity in this work cell.

To add a Guide to a resource group:

1. Go to Production control > Setup > Resources > Resource groupsProduction control > Setup > Resources > Resource groups .

2. From the list pane, select the resource group you want to assign a Guide to.

3. Expand the Associated GuidesAssociated Guides  FastTab.

4. Select AddAdd from the Associated GuidesAssociated Guides  toolbar. A new line is added to the grid.

5. For the new line, use the drop-down list in the NameName column to choose the Guide you want to assign. If you

have a large number of Guides, then you can filter the list to find the one you are looking for. 

You can add a guide to any released product.

Product-level Guides help shop floor workers with instructions relevant to operating or handling a specific

released product or item.

To add a Guide to a released product:

1. Go to Production information management > Products > Released productsProduction information management > Products > Released products .

2. Open the product you want to assign a Guide to.

3. On the Action Pane, open the EngineerEngineer  tab and from the ViewView  group, select Associated GuidesAssociated Guides .



  Associate a Guide to a formula

Typical scenario using formulasTypical scenario using formulas
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Add a Guide to a formulaAdd a Guide to a formula

4. The Associated GuidesAssociated Guides  page opens for your selected product.

5. Select AddAdd on the Action Pane to add a new line to the grid.

6. For the new line, use the drop-down list in the NameName column to choose the Guide you want to assign. 

You can add a guide to any formula.

Formula-level Guides provide shop floor workers with guided handling instructions in the context of a formula

or recipe. Guides can also be assigned to versions of a formula.

You can assign guidance relevant for production processes based on a formula to a route, route version, or route

operation relations.

Guides can't currently be attached to individual formula lines.

To add a Guide to a formula:

1. Go to Production information management > Bills of mater ials and formulas > FormulasProduction information management > Bills of mater ials and formulas > Formulas .

2. Open the formula you want to assign a Guide to.

3. Open the HeaderHeader  tab above the top FastTab.

4. Expand the Associated GuidesAssociated Guides  FastTab.

5. Select AddAdd from the Associated GuidesAssociated Guides  toolbar. A new line is added to the grid.

6. For the new line, use the drop-down list in the NameName column to choose the Guide you want to assign. 



  Associate a Guide to a formula version

Typical scenario using formula versionsTypical scenario using formula versions
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Add a Guide to a formula versionAdd a Guide to a formula version

You can add a guide to any formula version.

Guides attached to an individual version of a formula provide shop floor workers with instructions that walk

through the production of that version of the formula recipe.

You can assign guidance relevant for production processes based on this formula version to a route, route version, or

route operation relations.

Guides can't currently be attached to individual formula lines.

To add a Guide to a formula version:

1. Go to Production information management > Bills of mater ials and formulas > FormulasProduction information management > Bills of mater ials and formulas > Formulas .

2. Open the formula that includes a version that you want to assign a Guide to.

3. Open the HeaderHeader  tab above the top FastTab.

4. On the Formula versionsFormula versions  FastTab, select the version you want to assign a Guide to.

5. On the Formula versionsFormula versions  toolbar, select Associated GuidesAssociated Guides . 



  Associate a Guide to a bill of materials

Typical scenario using bills of materialsTypical scenario using bills of materials
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Add a Guide to a bill of materialsAdd a Guide to a bill of materials

6. The Associated GuidesAssociated Guides  page opens for your formula version.

7. Select AddAdd on the Action Pane to add a new line to the grid.

8. For the new line, use the drop-down list in the NameName column to choose the Guide you want to assign. 

You can add a guide to any bill of materials (BOM).

Guides attached to a BOM provide shop floor workers with instructions that explain how to prepare and handle

material from a BOM. Guides can also be assigned to versions of a BOM.

Guides can't currently be attached to individual BOM lines.



  Associate a Guide to a bill of materials version

Typical scenario using bill of materials versionsTypical scenario using bill of materials versions
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Add a Guide to a bill of materials versionAdd a Guide to a bill of materials version

To add a Guide to a bill of material:

1. Go to Production information management > Bills of mater ials and formulas > Bills of mater ialsProduction information management > Bills of mater ials and formulas > Bills of mater ials .

2. Open the bill of materials that you want to assign a Guide to.

3. Open the HeaderHeader  tab above the top FastTab.

4. Expand the Associated GuidesAssociated Guides  FastTab.

5. Select AddAdd from the Associated GuidesAssociated Guides  toolbar. A new line is added to the grid.

6. For the new line, use the drop-down list in the NameName column to choose the Guide you want to assign. 

You can add a guide to any bill of materials version.

Guides attached to an individual BOM version provide shop floor workers with instructions that explain how to

prepare and handle material for a version of a BOM that is different from the generic BOM or other versions of

it.

Guides can't currently be attached to individual BOM lines.

To add a Guide to a bill of materials version:

1. Go to Production information management > Bills of mater ials and formulas > Bills of mater ialsProduction information management > Bills of mater ials and formulas > Bills of mater ials .

2. Open the BOM that includes a version that you want to assign a Guide to.

3. Open the HeaderHeader  tab above the top FastTab.

4. On the BOM versionsBOM versions  FastTab, select the version you want to assign a Guide to.

5. On the BOM versionsBOM versions  toolbar, select Associated GuidesAssociated Guides . 



  Associate a Guide to a route

Typical scenario using routesTypical scenario using routes

Add a Guide to a routeAdd a Guide to a route

6. The Associated GuidesAssociated Guides  page opens for your BOM version.

7. Select AddAdd on the Action Pane to add a new line to the grid.

8. For the new line, use the drop-down list in the NameName column to choose the Guide you want to assign. 

You can add a guide to any route.

Routes are typically used to specify how a certain released product shall be produced based on a BOM or BOM

version and with a set of resources or resource groups.

Assign a Guide to a route to provide step-by-step instructions for the respective production process.

To add a Guide to a route:

1. Go to Production control > All routesProduction control > All routes .

2. Open the route that you want to assign a Guide to.

3. Expand the Associated GuidesAssociated Guides  FastTab.

4. Select AddAdd from the Associated GuidesAssociated Guides  toolbar. A new line is added to the grid.

5. For the new line, use the drop-down list in the NameName column to choose the Guide you want to assign. 



  Associate a Guide to a route version

Typical scenario using route versionsTypical scenario using route versions

Add a Guide to a route versionAdd a Guide to a route version

You can add a guide to any route version.

Routes versions are typically used to specify variants of production processes based on an existing route. You

can assign different Guides to each route version.

To add a Guide to a route version:

1. Go to Production control > All routesProduction control > All routes .

2. Open the route that you want to assign a Guide to.

3. On the VersionsVersions  FastTab, select the version you want to assign a Guide to.

4. On the VersionsVersions  toolbar, select Associated GuidesAssociated Guides . 

5. The Associated GuidesAssociated Guides  page opens for your BOM version.



  Associate a Guide to a route operation relation

Typical scenario using route operation relationsTypical scenario using route operation relations
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Add a Guide to a route operation relationAdd a Guide to a route operation relation

6. Select AddAdd on the Action Pane to add a new line to the grid.

7. For the new line, use the drop-down list in the NameName column to choose the Guide you want to assign. 

You can add a guide to any route operation relation.

Operation relations are the most specific way to add guidance to a product process and its related operations.

You can specify guidance for each operation in a route and specify different guidance for any type of relation

context specified for a route, such as for specific items, configurations, and more. You can also specify to which

stages in the operation the guidance applies (such as setup, queueing, process, or transport).

If you specify guides for several operation relations of a route, among those guides, only the guide from the most specific

relation will be show on the shop floor for the generated job.

To add a Guide to a route operation relation:

1. Go to Production control > All routesProduction control > All routes .

2. Open the route that you want to assign a Guide to.

3. On the Action Pane, open the RouteRoute tab and from the MaintainMaintain group, select Route detailsRoute details .

4. The Route detailsRoute details  page opens for your selected rout.

5. In the top grid, select the operation you want to provide guidance for.

6. In the bottom grid, select a specific relation (or the generic AllAll  relation). 
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Select guides from the shop floor execution interface

7. Above the bottom gird, open the Associated GuidesAssociated Guides  tab. 

8. Select AddAdd from the toolbar at the top of the bottom grid to add a new line to the grid.

9. For the new row, use the drop-down list in the NameName column to choose the Guide you want to assign. In the

rest of the row, select the check box for each context where the selected Guide should be available.

You can add one or more guides for each stage of each operation.

When a worker opens a job list on the shop floor execution interface, Supply Chain Management finds the

relevant guides for the jobs shown. Use the GuidesGuides  button to view the relevant guides.



 Resolving the logic for selecting Guides

Then put on a HoloLens and access the respective guide by glancing at the QR code and activating the

respective Guide.

You can add Guides to the following production data:

Resources

Resource groups

Released products

Formulas

Formula versions

Bills of material (BOMs)
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BOM versions

Routes

Route versions

Route operation relations

When Supply Chain Management generates the jobs for the production floor, it will collect the relevant Guides

from those sources. Take note of the following important rules.

If you attach a BOM version or formula version to a route or production order, then any Guides attached to

this version, and also the Guides attached to the parent BOM or formula of that version, will be shown on the

job.

If you attach a route version to a production order, then any Guides attached to this version, and also the

Guides attached to the parent route of that version, will be shown on the job.

If you define several route operation relations that include the All relation and assign Guides to those, only

the Guides from the most specific relation will be shown for the job.
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From Estimated to Created

From Scheduled to Estimated

From Released to Scheduled

From Started to Released

This topic describes how to reverse production order status.

If you reverse the status of a production order, the order and all operations that are associated with the routes

revert to a previous step in the production life cycle. For example, a production order has a status of ScheduledScheduled,

and you change the status back to CreatedCreated. In this case, the system must first change the status to EstimatedEstimated,

which is the status that immediately precedes ScheduledScheduled. It can then change the status to the status that you

want, CreatedCreated. Note:Note: If your order has reached the Repor t as finishedRepor t as finished status, you can still reverse it to an

earlier status. However, you must re-run estimation and operations scheduling, job scheduling, or both types of

scheduling, to update the information on the order. This step is required, because any reservations of remaining

item consumption and operations resource consumption must also be reset. The rest of this article explains

what occurs when you reverse the status of a production order in the following ways:

From EstimatedEstimated to CreatedCreated

From ScheduledScheduled to EstimatedEstimated

From ReleasedReleased to ScheduledScheduled

From Star tedStar ted to ReleasedReleased

When you reverse the status of a production order from EstimatedEstimated to CreatedCreated, the item consumption that was

calculated for the items in the bill of materials (BOM) is removed. Inventory transactions on the production line

are deleted, and the Remain statusRemain status  field on the production order's BOM lines is reset to EndedEnded. When the

Derived purchasesDerived purchases  and Derived productionDerived production options are selected, any underlying purchase orders or

production orders are deleted. If you estimated the costs of the production order, or if you manually reserved

items so that they could be used in production, those transactions are removed.

When you reverse the status of a production order from ScheduledScheduled to EstimatedEstimated, the scheduled start and end

dates and times are removed. Capacity reservations that were made during scheduling are removed, and jobs

that were created during job scheduling are deleted. All information that is recorded about operation scheduling

and job scheduling on the Production order detailsProduction order details  page is reset.

When you reverse the status of a production order from ReleasedReleased to ScheduledScheduled, the only change that occurs is

the value in the status field.

When you reverse the status of a production order from Star tedStar ted to ReleasedReleased, all items that were reported as

finished are reverted. If material has been picked, or if inbound and outbound deliveries have been made to

production, those settings are reversed. The Remain statusRemain status  field on the production order ’s BOM lines is

changed from EndedEnded to Mater ial consumptionMaterial consumption. If time has been registered, or if quantities have been

reported as finished for the operations in the production route, those settings are reversed. The Remain statusRemain status

field is changed from EndedEnded to Route consumptionRoute consumption in the production route. The settings for all items that are

posted as in process or work in process are reversed. On the Production order detailsProduction order details  page, fields that show

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/reverse-production-order-status.md
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a quantity that was started or reported as finished are reset. The dates for those transactions are also reset.
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Unreleased material lines needing attention

In the Production floor managementProduction floor management workspace, three tiles give you better visibility into exceptions for raw

materials for production orders and batch orders:

Unreleased material lines needing attention

Unprocessed waves needing attention

Open warehouse work needing attention

For all three tiles, the raw material date of the bill of materials (BOM) lines and formula lines is compared

against the workspace date, and also against the filters for Production unitProduction unit, Resource groupResource group, and ResourceResource

that are set on the Configure my work spaceConfigure my work space menu. By default, the workspace date is set to the current date,

but you can adjust it.

An unreleased BOM line or formula line requires attention if the raw material date of the line is the same as or

earlier than the workspace date, and if it meets the criteria that are defined by the filters in the workspace.

In the following figure, the blue bar represents a production job that is scheduled on a resource. The job is

scheduled to start on May 1, 2017 (2017/05/01). This date is the raw material date. In other words, the materials

that are assigned to the job on the BOM and formula lines must be ready on this date. The other date in the

figure, May 6, 2017 (2017/05/06), represents the workspace date. In this example, the raw material date is

earlier than the workspace date. Therefore, the date when consumption of the raw material was supposed to

start has passed, and the BOM and formula lines meet the criteria for requiring attention.

A BOM or formula line can be released to the warehouse in three ways:

As part of a production order or batch order release

As a manual release

Automatically through a batch job

For more information, see Release BOM and formula lines to the warehouse.

If a BOM or formula line hasn't been released or has been only partly released, and if the date and filter criteria

of the workspace are met, the line is included in the calculation of the number that appears on the UnreleasedUnreleased

material lines needing attentionmater ial lines needing attention tile.

When you select the tile, the Release to warehouseRelease to warehouse page is opened. This page shows the number of

unreleased BOM and formula lines that is indicated by the number on the tile. The unreleased lines appear in the

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/improved-visibility-into-material-exceptions.md
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Open warehouse work needing attention
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upper grid. This grid shows the quantity that was originally estimated for the line, the quantity that has already

been released, and the remaining quantity that must still be released. You can add lines from the upper grid to

the lower grid. From the lower grid, you can then release the selected lines to the warehouse. From the lower

grid, you can also adjust the quantity to release so that only a partial quantity is released.

When a BOM or formula line is released, it's added to either a new production wave or an existing open wave,

depending on the configuration of the production wave template. Through the configuration of the wave

template, you can also set up a wave so that it's automatically processed when a BOM or formula line is

released. When the wave is processed, warehouse work for raw material picking is generated. If the wave

template is configured so that waves aren't processed at the time of release, the wave remains in an

unprocessed state. The Unprocessed waves needing attentionUnprocessed waves needing attention tile shows the number of BOM and formula

lines that have been released to the warehouse on unprocessed waves, and that have a raw material date that is

earlier than or the same as the workspace date. The lines must also be consumed by an operation resource that

applies to the filter of the workspace.

When the tile is selected, the All production wavesAll production waves  page is opened. This page is filtered by the number of

open waves that contain wave lines from released BOM and formula lines that meet the criteria for the tile. From

the All production wavesAll production waves  page, you can manually process the wave.

The Open warehouse work needing attentionOpen warehouse work needing attention tile shows the number of BOM and formula lines that have

been released to the warehouse, that have unprocessed work, and that have a raw material date that is earlier

than or the same as the workspace date. The lines must also be consumed by an operation resource that applies

to the filter of the workspace.

When the tile is selected, the All workAll work page is opened. This page is filtered by the number of open work

headers that contain work lines from released BOM and formula lines that meet the criteria for the tile. From the

All workAll work page, you can manually process the work.
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Methods for releasing BOM and formula lines

Releasing the BOM and formula lines by using a batch job

Example of a batch job releaseExample of a batch job release

This topic describes the process for releasing raw material for bill of materials (BOM) lines and formula lines to

the warehouse. When you release a BOM or formula line to the warehouse, the system first determines whether

material is already available at the production input location on the shop floor where the material will be

consumed for the production process.

If the material is available at the production input location, it's picked from that location immediately after the

signal is given for the release of material to the warehouse.

If the material isn't available at the production input location, the material release indicates that material

must be moved from locations in the warehouse to the production input location. The material is moved via

warehouse work for raw material picking. Therefore, warehouse processes for raw material picking must be

configured. For more information, see Replenishment overview and Control warehouse work by using work

templates and location directives.

You can configure the release of BOM and formula lines so that it occurs as part of the release of a production

order or batch order. Alternatively, the release can be controlled by a batch job or done as a manual interaction.

The method that is used to release BOM and formula lines is controlled by the Production line releaseProduction line release

parameter. You can find this parameter at Production controlProduction control  > SetupSetup > Production parametersProduction parameters .

Release BOM and formula lines as par t of production or batch order releaseRelease BOM and formula lines as par t of production or batch order release – In this method,

BOM and formula lines for a production or batch order are released as part of the process of releasing the

order. Usually, during the release of a production or batch order, production jobs are released to the shop

floor workers, and production papers are printed. During this process, the status of the order is also changed

to ReleasedReleased.

Release BOM and formula lines via a batch job or as a manual interactionRelease BOM and formula lines via a batch job or as a manual interaction – In this method, BOM

and formula lines can be released only through the Automatic release of BOM and formula linesAutomatic release of BOM and formula lines  batch

job or as a manual interaction. To manually release BOM and formula lines, on the production order list page

or the production order details page, on the Action Pane, select Release to warehouseRelease to warehouse.

For a quick demonstration of how to release BOM and formula lines to production by using a batch job, watch

this short YouTube video: Release production picking to the warehouse in batch.

The Automatic release of BOM and formula linesAutomatic release of BOM and formula lines  batch job goes through selected BOM and formula lines

that have a remaining quantity to release. The job considers only orders that have a status of ReleasedReleased,

Star tedStar ted, or Repor ted as finishedRepor ted as finished. If a BOM or formula line has a remaining quantity to release, the job

releases up to the quantity that can be covered by the quantity that has already been physically reserved and the

quantity that is physically available.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/releasing-bom-and-formula-lines-to-warehouse.md
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Batch job setupBatch job setup

Releasing material per operation number or in proportion to the
amount of finished goods

Release material per operation numberRelease material per operation number

In the query for the Automatic release of BOM and formula linesAutomatic release of BOM and formula lines  batch job, you can set up a filter criterion

to specify how many days ahead the job should look for lines that have unreleased quantities. In the query for

the job, in the Raw mater ial dateRaw mater ial date field, use the (LessThanDate())(LessThanDate())  function as a filter criterion.

The following illustration shows a production order that has two jobs, 10 and 20, that cover the assembly and

packing for the production order. Each job is set up to consume a quantity of material. In this illustration, the

release time fence that is indicated by the green arrow below the time line equals the number of days that has

been specified in the (LessThanDate())(LessThanDate())  criterion. For example, (LessThanDate(2))(LessThanDate(2))  indicates that the job

should look for unreleased quantities only within a time fence of two days.

If you release materials by using the On production order releaseOn production order release parameter setting, when you do a manual

release, you have two options for controlling the material release:

Release material per operation number.

Release material in proportion to the amount of finished goods.

To control the operations that material should be released to, use the Release to warehouseRelease to warehouse page.

Select Production controlProduction control  > Production ordersProduction orders  > All production ordersAll production orders , select a production order, and

then, on the WarehouseWarehouse tab, select Release to warehouseRelease to warehouse. Then use the From Oper. No.From Oper. No. and To Oper.To Oper.

NoNo fields to specify the range of operation numbers.

The following illustration shows a production order that has two operations, 10 and 20. In this example, if you

limit the release to operation 10, only material M9203 will be released.



Release material in proportion to the amount of finished goodsRelease material in proportion to the amount of finished goods
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For a quick demonstration of how to release material in proportion to the amount of finished goods, watch this

short YouTube video about enhancements to the production order release process.

You can release raw material for a partial quantity of finished goods or in a specific unit.

To release raw material for a partial quantity of finished goods, select Production controlProduction control  >

Production ordersProduction orders  > All production ordersAll production orders , select a production order, and then, on the WarehouseWarehouse

tab, select Release to warehouseRelease to warehouse. Then enter a quantity in the QuantityQuantity  field.

For example, a production order is created and scheduled for 1,000 pieces (pcs.). The shop floor

supervisor is planning the production of 100 pcs. for the next shift and wants to release materials only for

that shift. In this case, the supervisor can use the QuantityQuantity  field to release materials for the 100 pcs. that

are planned for the next shift.

To release raw material in a specific unit, select Production controlProduction control  > Production ordersProduction orders  > AllAll

production ordersproduction orders , select a production order, and then, on the WarehouseWarehouse tab, select Release toRelease to

warehousewarehouse. Then use the UnitUnit field to select the unit of the finished good to release material in.

The units that are available are defined in the unit sequence group ID of the finished good.

For example, a finished good has the following unit conversion between pounds (lbs.) and pallet (PL): 1

PL = 100 lbs. To create a production order for 10,000 lbs. of the finished good, you can release raw

materials for the number of pallets that you plan to produce. Select PLPL  as the unit, and then select a

corresponding number in the QuantityQuantity  field.
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Introduction

Scenario detailsScenario details

Set up the workflow to register consumption using a handheld device

This topic describes a workflow that enables registration of raw material consumption in production by using a

handheld device.

This workflow is relevant if there is a strict requirement for material traceability. In those cases, to maintain

traceability of the materials, the exact time and quantity must be reported for the consumption. This process can

be seen as opposed to pre- or back-flushing operations, where there is an offset between the time of

registration and the time when the actual consumption takes place. This explains why a strategy of automatic

consumption cannot be used for some materials with traceability requirements. Let’s look at a simple scenario

that explains how to set up a workflow to enable registration of raw material consumption in production by

using a handheld device. 

A continuous production process (5) consumes the batch-controlled raw material RM-100. The material is on-

hand on location Bulk-001 (1) on license plate PL-1 with two batches, B1 and B2, both with a quantity of 100 lbs.

Warehouse work (2) is released and processed for RM-100, and the material is picked from Bulk-001 to the

production input location PIL-01 (3), which is defined as non-license plate controlled. The machine operator

weighs out material from the production input location (3) and registers the weight and batch number as

consumed (4). From the production input location, a portion of the material is manually added to the production

process in defined time intervals. When the machine operator adds material, it is weighed on a scale and the

batch number is registered.

Create a finished-good product, FG-100, with a bill of material that has the batch-controlled raw material RM-

100. Add two batches, B1 and B2, of RM-100 in a quantity of 100 to location: Bulk-001 on license plate: PL-1. The

flushing principle on the bill of material line for RM-100 is set to ManualManual . Set  the production input location to

PIL-01. You can do that by selecting this location as the default production input location on warehouse 51.

1. Create a new mobile device menu item:

Menu item nameMenu item name - Register material consumption.

TitleTitle - Register material consumption.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/register-material-consumption-hand-held-device.md
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ModeMode - Indirect.

Activity codeActivity code - Register material consumption.

2. Add the menu item to the Production MobileProduction Mobile device menu.

3. Create a production order for the finished product:

Item numberItem number  - FG-100

SiteSite - 5

WarehouseWarehouse - 51

QuantityQuantity  - 150

The production order is EstimatedEstimated and ReleasedReleased and warehouse work is created.

4. Complete the work using the workflow for raw material picking for the handheld device.

This will bring the material from the bulk location to the production input location PIL-01. After the work is

completed, the material has the status Picked on the production input locationPicked on the production input location. The status after work has

been processed can be either PickedPicked or Reser ved physicalReser ved physical . This is configured with the parameter IssueIssue

status after put on the warehouse formstatus after put on the warehouse form .

5. Start the production order either from the client or from the handheld device by using the Production star tProduction star t

menu item.

After the production order has been started, you can register material consumption with the workflow for the

handheld device. Let's start by registering consumption of 25 lbs of batch B1.

6. Select the Register mater ialRegister mater ial  consumptionconsumption menu item in the menu for the hand held device, enter the

following details:

The production order number.

The location on which the material is going to be consumed, in this case PIL-01.

Item number RM-100.

Batch number B1.

A quantity of 25.

7. Select OKOK.

Note that the message "Journal line is created" appears on the display. On the production order there is an open

journal of the type Production picking listProduction picking list for item number RM-100 and batch number B1.

You can now choose to continue your registration, for example on batch number B2, and each time you select

OK,OK, a new journal line is added to the open journal.

After you have finished your registration, select DoneDone to post the journal and end the workflow.

If a user cancels the workflow after a journal line is created, the journal is in an unposted state but if the user

at a later point uses the workflow for the same production order, then the lines will be added to the open

journal rather than to a new journal.

The new workflow also supports the registration of serial numbers.

It is only possible to register an item number that is defined in the bill of material or in the formula for the

selected production order or batch order.

Material can be overconsumed. For example, if the material is estimated to be consumed with the quantity of

100 lbs, then it can be overconsumed with a quantity of, for example, 105 lbs.
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Description of the flushing principles
ManualManual

StartStart

The flushing principles reflect different consumption strategies for raw materials that are used in production

processes. Consumption is the process that deducts material from the on-hand inventory and sets the value of

the consumed materials to Work in progressWork in progress  (WIP) for production orders and batch orders. Raw materials are

usually consumed from a location that is configured for the process that consumes the material. This location is

known as the production input location.

Before material consumption, the materials are moved to the input location. The following illustration shows the

process.

1. Material warehouse

2. Raw material picking

3. Production input location

4. Raw material consumption

5. Production process

Material consumption is controlled by the following four flushing principles:

Manual

Start

Finish

Available at location

The flushing principles are configured in a hierarchy of default values. The hierarchy starts at the released

product, where the flushing principle has the value Star tStar t. On the bill of materials (BOM) or formula line, the

flushing principle from the product can be overridden. The default flushing principle on the production BOM

lines or batch order formula lines is taken from the product or the overridden value on the BOM or formulas.

The Manual flushing principle indicates that the registration of material consumption is a manual operation. This

principle is relevant if, for example, you want to be able to track time, and the quantity of consumed batch

numbers or serial numbers must be accounted for, for tracking purposes. Manual consumption is registered in a

production picking list journal. For items that are enabled for advanced warehouse processes, a hand-held flow

can be applied.

The Start flushing principle indicates that material will be automatically consumed when the production order is

started. The amount of material that is consumed is proportional to the quantity that is started. When the Start

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/flushing-principles.md
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FinishFinish

Available at locationAvailable at location
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flushing principle is used together with the manufacturing execution system, it can also be used to flush

materials when an operation or a process job is started. This principle is relevant if, for example, the variance in

the consumption is low, the materials are low-value materials, there are no tracking requirements, or there is a

short run time on operations.

The Finish flushing principle indicates that material will be automatically consumed when the production order

is reported as finished, or when an operation that is set up to consume the materials is registered as completed.

The amount of material that is consumed is proportional to the quantity that is reported as finished. When the

Finish flushing principle is used together with the manufacturing execution system, it can also be used to flush

materials when an operation or a process job is completed. This principle is relevant in the same situations as

the Start principle. However, the Finish principle is for operations that have a longer run time, where materials

should not be set to WIP before the operation is completed.

The Available at location flushing principle indicates that the material will be automatically consumed when it's

registered as picked for production. The material is registered as picked from location when work for the raw

material picking is completed, or when material is available on the production input location and the material

line is released to the warehouse. The picking list that is generated during the process is posted in a batch job.

This principle is relevant if, for example, you have many picking activities against one production order. In this

case, you don't have to update the picking list manually, and you can get a current view of the WIP balance.
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This topic describes the hierarchy that is used to identify the production output location.

The production output location is the location where a finished good is first stored after it's produced. Usually,

this location is close to the production process that produces the finished good. The production output location

is used as intermediate storage for the material before it's moved on to the shipment area, a storage location, a

production input location for a downstream production process, and so on.

A default production output location is set when finished goods are reported on a production order or batch

order. The following hierarchy is used to identify this output location:

1. Use the output location that is defined on the production order or batch order header.

2. If no location is found there, use the output location that is defined on the resource that is used by the last

operation that is defined in the production route.

3. If no location is found there, use the output location that is defined on the resource group that is used by the

resource for the last operation that is defined in the production route.

4. If no location is found there, use the output location that is defined on the warehouse that is defined for the

production order.

A default production output location is set only for products that are set up by using advanced warehouse

processes. When this type of item is reported as finished, warehouse work of the Finished goods put awayFinished goods put away  or

Co-product and by-product put awayCo-product and by-product put away  type is created. This type of work uses the production output location

as the pick location. The put-away location is determined by the location directives.
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Report as finished page

Max. report as finished page
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BOMs that have multiple levels

This article provides information about reporting BOMs as finished.

The Repor t as finishedRepor t as finished and Max. repor t as FinishedMax. repor t as Finished pages are used to report bills of materials (BOMs) as

finished. Conceptually, the process for reporting a BOM as finished is the same as the process for reporting a

production order as finished. This process can be used in, for example, simple assembly and kitting processes,

where the more advanced capabilities of production orders aren't required. The Repor t as finishedRepor t as finished page lets

you report multiple BOMs as finished in a batch. The Max. repor t as FinishedMax. repor t as Finished page lets you report only one

BOM as finished at a time. The Repor t as finishedRepor t as finished page is available from a menu item in Inventory

management, and both pages are available as a menu items on the Released productsReleased products  page.

If you open the Repor t as finishedRepor t as finished page from a released product, the page suggests that you report the

standard inventory default quantity as finished. By default, the active BOM version is shown, but you can change

the BOM version if there are other approved versions. The page also lets you delete records and create new

records for released products that should be reported as finished. To use a query to select products, click the

SelectSelect menu item. You can manually confirm reporting as finished for the selected products by clicking OKOK.

Alternatively, you can set up the process to run in a batch. When the report as finished process is confirmed, the

system generates a BOM journal where the posting to inventory is processed. This journal consists of one line

item for the finished product and a line item for each BOM line. You can control whether the journal is

automatically posted or whether it is left open for additional adjustments.

On the Max. repor t as finishedMax. repor t as finished page, each BOM line indicates the number of pieces of the product that can be

reported as finished. This calculation is based on the physical available on-hand inventory of each material line.

In the following example, one piece of item number FG consumes two pieces of raw material RM10 and one

piece of raw material RM20. Because there are only 10 pieces of RM10 on hand, the maximum quantity of FG

that can be reported as finished is five pieces. This value is shown in the Max. Repor t as finishedMax. Repor t as finished field.

When a BOM has multiple levels, you can control how materials are accounted for at all levels by using the

ExplosionExplosion field. This field is available on both the Repor t as finishedRepor t as finished page and the Max. repor t as FinishedMax. repor t as Finished

page. The following options are available:

NeverNever  – Underlying BOMs aren't exploded if there is a material shortage.

AlwaysAlways  – All underlying BOMs are fully exploded. Therefore, any free on-hand inventory for semi-finished
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component items isn't used.

Shor tageShor tage – Underlying BOMs are exploded only if the full quantity of the material that is wanted isn't

available.

In this example, three pieces of the finished product (item number FG) are ready to be reported as finished.

There is a two-level BOM, as shown here.

The following tables show how the setting of the ExplosionExplosion field affects the way that BOM journal lines are

generated. Explosion: NeverExplosion: Never

As the preceding table shows, only item number COMP is considered deducted in the journal. Item number RM,

which is part of COMP, isn't exploded to the journal line, and the two on-hand pieces of COMP aren't considered.

Explosion: AlwaysExplosion: Always

In this case, item number COMP is exploded into its raw material, item number RM. The two on-hand pieces of

COMP aren't considered in the quantity of RM to consume. Explosion: Shor tageExplosion: Shor tage

In this case, the two on-hand pieces of item number COMP are considered. However, because three pieces of

item number FG are required, one piece of item number RM is also required in order to make the additional one

piece of COMP.
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Set up an output location

Create a production order and report it as finished

This task guide shows an example of reporting as finished to a location that isn't license plate–controlled. An

applicable work policy is the prerequisite for this task. A previous task guide showed the setup of the work

policy. This task guide requires Dynamics AX application 7.0.1 or later.

1. Go to Organization administration > Resources > Resource groups.

2. In the list, select resource group '5102'.

3. Click Edit.

4. In the Output warehouse field, enter '51'.

5. In the Output location field, enter '001'.

Location 001 isn't a license plate–controlled location. You can set up a non–license plate output

location only if an applicable work policy exists for the location.

1. Close the page.

2. Go to Production control > Production orders > All production orders.

3. Click New production order.

4. In the Item number field, enter 'L0101'.

5. Click Create.

6. On the Action Pane, click Production order.

7. Click Estimate.

8. Click OK.

9. Click Start.

10. Click the General tab.

11. In the Automatic BOM consumption field, select 'Never'.

12. Click OK.

13. Click Report as finished.

14. Click the General tab.

15. Select Yes in the Accept error field.

16. Click OK.

17. On the Action Pane, click Warehouse.

18. Click Work details.

When the production order was reported as finished, no work was generated for put-away. This

occurs because a work policy is defined that prevents work from being generated when product

L0101 is reported as finished to location 001.
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This procedure shows you how to start and report progress on a production job in the job device registration

form.

To be able to run this procedure you must have the System administator or Machine Operator role associated

with the user account.

1. Go to Production control > Manufacturing execution > Job card device.

2. In the WorkerTextField field, enter the badge of a worker. In the USMF demo data type '123' for Christina

Portra..

3. Click Log in.

4. Click the Filter button.

5. Check or uncheck the Apply configuration filter check box. If you set a filter you can use production unit 110

in USMF.

6. In the Production unit field, select the ressource group for which production jobs the worker can work on.

7. In the list, click the link in the selected row.

8. Click OK.

9. Click the Start job button.

10. Click OK.

11. Click the Report progress button.

12. Click OK.

13. Click the Next job button.

14. Click the Assigned to see an overview of all production jobs button.

15. Close the page.

16. Click the Break button.

17. In the list, find and select the desired record.

18. Click OK.

19. Click the Leaving button.

20. Select to log out.

21. Click OK.

22. In the WorkerTextField field, log in again. You can select worker '123' in USMF demo data.

23. Click Log in.

24. Click Stop break.

25. Click the Activity button.

26. Click Cancel.

27. Click the Leaving button.

28. Select to clock out.

29. Click OK.

30. Select a reason why you are clocking out early.
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Create a new safety stock journal name

Create a safety stock journal

Calculate proposal

Update minimum quantity

This procedure shows how to calculate minimum coverage proposals based on historical transactions and then

update the item coverage with the proposals. This is done using the safety stock journal. The demo data

company used to create this task is USMF. This task is intended for the production planner, to help maintain

minimum coverage.

1. In the Navigation paneNavigation pane, go to Master planning > Setup > Safety stock journal namesMaster planning > Setup > Safety stock journal names .

2. Click NewNew .

3. In the NameName field, type 'Material'.

4. In the Descr iptionDescr iption field, type 'Material'.

5. Close the page.

1. In the Navigation paneNavigation pane, go to Master planning > Master planning > Run > Safety stockMaster planning > Master planning > Run > Safety stock

calculationcalculation.

2. Click NewNew .

3. In the NameName field, enter or select a value. Select the safety stock journal name that you created, for example,

Material.

4. Click Create linesCreate lines .

5. In the From dateFrom date field, enter a date.

6. In the To dateTo date field, enter a date.

7. Click OKOK. This will create lines for the dimensions that have inventory transactions.

1. Click Calculate proposalCalculate proposal .

2. Select the Use average issue during lead timeUse average issue during lead time option.

3. Set Multiplication factorMultiplication factor  to '10'. The Multiply factor is used to adjust the proposal. Because demo data only

has a few transactions, you will need to set the factor to get a realistic proposal.

4. Click OKOK. Scroll down to find M0002 and M0003. View the Calculated minimumCalculated minimum quantity column.

1. In the New minimum quantityNew minimum quantity  field, enter a number. Update the New minimum quantity to match the

value in the Calculated minimum quantity. If the Calculated minimum is zero, you can enter the desired

future value. For example, you can enter the Calculated minimum quantity in this field for M0002 that has

warehouse 12.

2. In the list, find and select the desired record. For example, you can select M0002 that has warehouse 12.

3. In the New minimum quantityNew minimum quantity  field, enter a number. Update the New minimum quantity to match the

value in the Calculated minimum quantity. If the Calculated minimum is zero you can enter the desired future

value.
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1. Click PostPost.

2. Click OKOK.

3. Click to follow the link in the Item numberItem number  field.

4. Click to follow the link in the Item numberItem number  field.

5. On the Action PaneAction Pane, click Plan.

6. Click Item coverageItem coverage. Notice that the Minimum quantityMinimum quantity  has been updated with the new minimum

quantity from the safety stock journal.
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Substituting material by date

Substituting material by planning

Substituting material during production

This topic describes how to substitute materials during the production process.

There are three methods for substituting materials during the production process:

By date, when one material is substituted for another after a specific date

During master planning, when a material in a formula is substituted with a different material, because it's out

of stock

During production, when a material is unexpectedly out of stock and is substituted with a different material

Consider following scenario: A machine that a company is manufacturing contains a component that will expire

from the vendor's catalog in two months. From the expiration date onward, the vendor will offer a new

component that can be substituted for the old component. From and to validity dates can be set up on bill of

materials (BOM) lines. For this example, you set up the old component to expire by entering the expiration date

in the To-dateTo-date field. Then, on the BOM, you set up the new, replacement component so that it's valid from the

day after the old component expires. To do this, enter the start date in the From-dateFrom-date field.

You can substitute materials during planning only when you're using formulas, not when you're using a BOM.

Consider following scenario: A food manufacturing company is making a sauce from a formula that has 20

ingredients. One ingredient in the formula can be substituted by one of two other ingredients. However, because

these two ingredients are more expensive than the preferred ingredient, substitution is used only if the

preferred ingredient is out of stock. The material that can be substituted is called A, whereas the two materials

that can replace it are called B and C. Material substitution by planning is controlled by the Plan groupPlan group and

Prior ityPr ior ity  fields on the formula lines. For this example, you create formula lines for the three materials, and

associate the formula lines with the same plan group. In the setup, the formula line for material A has the

highest priority (lowest number), the formula line for material C has the lowest priority, and the formula line for

material B has a priority that is between the priority of the other two lines. If you have demand for the finished

item, master planning first determines whether the demand for material A can be covered. If the demand can't

be covered, master planning looks at materials B and C, in order of priority. If material B is on hand, it will be

used after a planned batch order is firmed for the formula. If none of the materials are on hand, master planning

creates a planned order for material A. Note:Note: When you set up formula lines in a plan group, you should specify

a quantity only on the material that has the highest priority. This quantity will be used to calculate the demand of

all materials in the plan, even the materials that have lower priority. You can't specify different quantities on

lower-priority items in the plan group.

Consider the following scenario: A piece of metal plate is required for a welding operation. During the operation,

a warehouse worker informs the machine operator that the plate is out of stock. However, it's decided that the

plate can be substituted with a plate that is slightly thicker. That way, the operation can be finalized. Material can

be added to the BOM for an open production order. If the production order has a status of Star tedStar ted, users are

asked to re-estimate the order when they add a new item to the production BOM. After the material is added, a

new picking list can be created for the new item. You don't have to add the new material to the production BOM.

Instead, you can add it directly to the production picking list. Then, when the picking list is posted, the system
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adds the material to the production BOM.
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Manufacturing execution and registration terminology

T ERMT ERM DESC RIP T IO NDESC RIP T IO N

Manufacturing execution A function that is used to register time, material
consumption, costs on production jobs, projects, and indirect
activities. Registration is done in a manufacturing execution
registration client.

Job list On the Job registrationJob registration page, workers are shown the list
of jobs that they must perform on a specific resource, such
as a machine. A worker can register time and item
consumption on each job or task in the job list.

Job bundling If a worker starts more than one job at the same time on
the Job registrationJob registration page, this is called job bundling. The
time that is spent on bundled jobs can be allocated to the
individual jobs in various ways by using allocation keys.

Pilot/assistant registrations A worker can register as an assistant to a resource, and can
create a small team where several workers work on the same
production jobs. Resources that workers are connected to as
assistants are called pilots. Only the pilot resource must
make registrations. All assistants automatically get the same
registrations. For example, if a machine acts as the pilot,
workers who have registered as assistants to that machine
can make registrations on the Job registrationJob registration page, and
both the machine and the workers who are connected as
assistants will receive the same registrations.

Indirect activity An activity or task that isn't directly related to a production
job or a project, such as a department meeting, a cleaning
job, or a maintenance job on the shop floor. Workers can
make registrations on indirect activities, in the same way
that they can register on production jobs and projects.

Registrations in manufacturing execution

This topic describes key concepts and terms that you need to understand to configure and use manufacturing

execution.

Manufacturing execution is intended to be used primarily by manufacturing companies. Workers can register

time and item consumption on production jobs by using the Job registrationJob registration page. All registrations are

approved and are later transferred to the relevant modules. Continuous approval and transfer of registrations

lets managers easily track actual costs on production orders.

The following table contains terms that pertain to manufacturing execution and related registration tasks.

Workers can make various types of registrations in manufacturing execution for work that is performed on

production jobs. Depending on the system setup, workers might also be able to make registrations on project

activities and nonproductive tasks, such as breaks, absences, and indirect activities. Here are the registration
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types:

Clock-in/clock-outClock-in/clock-out (available with time and attendance) – Workers clock in when they arrive at work and

clock out when they leave to go home.

Register on production jobsRegister on production jobs  – Workers can make registrations, such as starting a job and reporting

feedback for a job, on the production jobs that appear in their job list. Workers can start several jobs at the

same time. This is referred to as job bundling.

Register on inventor yRegister on inventor y  – Workers can make registrations on materials that are used on the shop floor, but

that aren't directly related to production jobs. Examples include grease, lubricants, or other materials that are

used to keep machinery running. Registration is performed in an inventory journal.

Register on projectsRegister on projects  (available with time and attendance) – Workers can make registrations, such as

starting and finishing work on the projects or project activities that appear in their job list.

Register project fees and project itemsRegister project fees and project items (available with time and attendance) – Workers can register fees

(expenses) that are associated with a project in a project fee journal, such as mileage and bridge toll. Workers

can also register item consumption on projects. This is done in a project item journal.

Register as assistant to another workerRegister as assistant to another worker  – If two or more workers will work together on a production job

or a project, a worker can register as an assistant to a machine, or to another worker, who will then act as the

pilot. The pilot can select another worker as the pilot, as required.

Register absenceRegister absence (available with time and attendance) – Workers can register time on various absence

codes that are set up. Absence can be indicated if a worker arrives late, requires absence during the work day,

or leaves earlier than expected according to the standard work time profile.

Register breaksRegister breaks  (available with time and attendance) – During the work day, workers can register that they

are leaving their workstation to take a break. Several break types can be set up. When a worker returns and

logs on again, the system registers that the worker is back, and the break registration stops.

Register indirect activitiesRegister indirect activities  (available with time and attendance) – Indirect activities are nonproductive

activities that workers might engage in during a workday, such as a department meeting, a team meeting, or

a maintenance job that is performed on the shop floor. Workers can make registrations on the indirect

activities that are set up.

Register over timeRegister over time (available with time and attendance) – Workers who have been asked to work longer

hours can select whether the extra hours should be registered as flextime or overtime.
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This article provides information about production feedback, which gives workers feedback about production

jobs. The article includes information about the various ways that production feedback can be updated.

Production feedback gives workers feedback about production jobs. It records time and material consumption

on production orders, operation quantities and status, and errors that cause a job or operation to fail. Production

feedback can be updated in journals that are related to production orders. The Production job cardProduction job card and

Production route cardProduction route card journals are used to report time and quantities per job or operation. For reporting

about the last job or operation, quantities on the finished product can be reported as finished. Production

feedback can also be updated on the Job card terminalJob card terminal  and Job card deviceJob card device pages. These pages enable

production feedback to be updated on the shop floor and are part of the manufacturing execution functionality

in the Production controlProduction control  module. The Job card terminalJob card terminal  page has a configurable user interface that shows

a list of the released jobs in a prioritized order for a selected work area. It also offers advanced options such as

job bundling and team work. The Job card deviceJob card device page has a touch-optimized user interface. Production

feedback on both pages is updated from the production journals.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/production-feedback.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Enable the payroll process for time and attendance
2/18/2021 • 2 minutes to read • Edit Online

Create a pay type with a related pay rate

Create a pay agreement

Set up pay agreement for time and registration worker

This procedure shows how to enable the payroll process for time and attendance. The demo data company used

to create this procedure is USMF.

1. Time and attendance > Setup > Payroll > Pay types

2. Click New.

3. In the Pay type field, type a value.

4. In the Description field, type a value.

5. Click Save.

6. Click Rates.

7. Click New.

8. In the list, mark the selected row.

9. In the Rate field, enter a number.

10. Click Save.

Rates for pay types are set up for specific time intervals, and individual rates can be created for

workers. It is not always necessary to create rates for pay types in time and attendance. This

information may already exist in the payroll system that is used to generate wages.

1. Close the page.

2. Close the page.

3. Go to Pay agreements.

4. Click New.

5. In the Pay agreement field, type a value.

6. In the Description field, type a value.

7. Click Save.

8. Click Agreement lines.

9. Click New.

10. In the list, mark the selected row.

11. In the Profile type field, enter or select a value.

12. In the Pay type field, enter or select a value.

Time and attendance > Setup > Pay agreements

1. Close the page.

2. Close the page.

3. Go to Time registration workers.

4. In the list, click the link in the selected row.

5. Click the Employment tab.

Time and attendance > Setup > Time registration workers
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6. Expand the Time registration section.

7. Click Edit.

8. In the Pay agreement field, enter or select a value.
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Verify that a worker is assigned a certain role

Configure worker account

Assign worker to device group

This topic explains how to assign the correct roles to the user account of a worker, and then enable the worker to

do shop floor registrations.

For this example, verify that user "SHANNON" is assigned the machine operator role before you configure the

worker account.

1. Go to Navigation pane > Modules > System administration > Users > UsersNavigation pane > Modules > System administration > Users > Users .

2. Search for a user in the quick filter. For this example, enter shannon .

3. Select the link in the User IDUser ID column of the user account that appears.

4. In the User 's rolesUser 's roles  tree, select Roles > Machine operatorRoles > Machine operator .

5. Close the user detailsuser details  and usersusers  pages to return to the home page.

1. Go to Navigation pane > Modules > Human resources > Workers > WorkersNavigation pane > Modules > Human resources > Workers > Workers .

2. Search for a user in the quick filter. For this example, enter shannon .

3. Select the link in the NameName column of the user account that appears.

4. Select the Time registrationTime registration tab.

5. Select Activate on registration terminalsActivate on registration terminals .

6. Enter or select values in the following fields:

Calculation groupCalculation group

Default calculation groupDefault calculation group

Approval groupApproval group

Standard profileStandard profile

Profile groupProfile group

7. Select OKOK.

8. Select EditEdit to enter a badge number for the new time registration worker. Enter a value in the Badge IDBadge ID

field.

9. Select SaveSave.

10. Close the Worker detailsWorker details  and WorkersWorkers  pages.

1. Go to Production control > Setup > Manufactur ing execution > Configure job card for devicesProduction control > Setup > Manufactur ing execution > Configure job card for devices .

2. Select AddAdd.

3. In the list, select the desired worker. For this example, select SHANNONSHANNON.

4. Select OKOK.

5. Select EditEdit.
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6. In the Production unitProduction unit field, you can set the default filter for the worker. This will ensure that only

production jobs for the selected production unit are shown when the worker logs on to the device. Enter the

desired value.

7. Close the page.
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Example scenario

JO BJO B P RO DUC T IO N  T IM EP RO DUC T IO N  T IM E

Job 1 1 hour

Job 2 3 hours

Job 3 4 hours

Total 8 hours

JO BJO B STA RT  T IM ESTA RT  T IM E EN D T IM EEN D T IM E B UN DL E T IM EB UN DL E T IM E

Job 1 09:00 11:00 2 hours

Job 2 10:00 13:00 3 hours

Job 3 10:00 15:00 5 hours

Bundle 09:00 15:00 6 hours

In Manufacturing execution, you can bundle jobs. You can then start multiple jobs at the same time on the Job

list page.

If you bundle jobs, you must define how the total registered time for all the jobs should be allocated to each job.

You define the allocation by selecting one of the following options in the Bundle typeBundle type field on the AllocationAllocation

keyskeys  page:

EstimationEstimation – Time is divided among the jobs, based on the estimated time for the jobs.

JobsJobs  – Time is divided according to total jobs that are bundled and how much time was spent finishing all

the jobs.

Net timeNet time – Time is divided equally among the jobs that are in the bundle at any time.

Real timeReal time – Actual job time is allocated. The cost can be calculated based on the actual payroll cost. Note:Note:

The Real timeReal time allocation key is available only if your company uses the payroll functionality in Time and

attendance.

The following examples show the results of the various allocation keys.

Three jobs in your job queue must be completed. You start the first job, and then, while that job is in progress,

you start the second and third jobs. Therefore, there is a bundle of three jobs. The following table shows the

estimated production time for each job.

The following table shows the actual work hours that are spent on each job.

The following sections describe the results of the calculated time for each allocation key.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/allocate-time-jobs-job-bundle.md


Estimation allocation key

JO BJO B F O RM UL AF O RM UL A A L LO C AT ED T IM EA L LO C AT ED T IM E

Job 1 6 × (1 ÷ 8) hours 0.75 hour

Job 2 6 × (3 ÷ 8) hours 2.25 hours

Job 3 6 × (4 ÷ 8) hours 3.00 hours

Jobs allocation key

JO BJO B F O RM UL AF O RM UL A A L LO C AT ED T IM EA L LO C AT ED T IM E

Job 1 6 ÷ 3 2 hours

Job 2 6 ÷ 3 2 hours

Job 3 6 ÷ 3 2 hours

Net time allocation key

09: 00–10: 00 ( 109: 00–10: 00 ( 1
H O UR)H O UR)

10: 00–11: 00 ( 110: 00–11: 00 ( 1
H O UR)H O UR)

11: 00–13: 00 ( 211: 00–13: 00 ( 2
H O URS)H O URS)

13: 00–15: 00 ( 213: 00–15: 00 ( 2
H O URS)H O URS)

A L LO C AT EDA L LO C AT ED
T IM ET IM E

Number of jobs
in the bundle

1 3 2 1 Not applicable

Job 1 1 ÷ 1 = 1 hour 1 ÷ 3 = 0.33
hour

Not applicable Not applicable 1.33 hours

Job 2 Not applicable 1 ÷ 3 = 0.33
hour

2 ÷ 2 = 1 hour Not applicable 1.33 hours

Job 3 Not applicable 1 ÷ 3 = 0.33
hour

2 ÷ 2 = 1 hour 2 ÷ 1 = 2 hours 3.33 hours

Real time allocation key

The following table illustrates the formula for calculating allocated time. Here is the formula: Time per job =

Total bundle time × (Estimated job time ÷ Total estimated time)

The following table illustrates the formula for calculating allocated time. Here is the formula: Time per job =

Total bundle time ÷ Number of jobs

The following table illustrates the formula for calculating allocated time. Here is the formula: Calculated time per

reporting = Bundle time ÷ Number of jobs

If you want production costs to be calculated based on real costs, you must clear the Cost categor yCost categor y  option on

the Production order defaultsProduction order defaults  page. The following table illustrates the formula for calculating allocated time.

Here is the formula: Actual time per job = Actual time in bundle



JO BJO B A C T UA L  T IM EA C T UA L  T IM E

Job 1 2 hours

Job 2 3 hours

Job 3 5 hours

JO BJO B

C A L C UL AT IO N  O FC A L C UL AT IO N  O F
C O RREC T ED C O STC O RREC T ED C O ST
P ER H O URP ER H O UR

C O RREC T ED C O STC O RREC T ED C O ST
P ER H O URP ER H O UR A L LO C AT ED T IM EA L LO C AT ED T IM E TOTA L  C O ST  O F  JO BTOTA L  C O ST  O F  JO B

Job 1 (1.33 ÷ 2) × USD
12.00

USD 8.00 2 hours USD 16.00

Job 2 (1.33 ÷ 3) × USD
12.00

USD 5.33 3 hours USD 16.00

Job 3 (3.33 ÷ 5) × USD
12.00

USD 8.00 5 hours USD 40.00

NOTENOTE

Consider the three jobs that are performed by a worker who has an hourly wage of USD 12.00. No overtime

bonus or premium was earned in the time that was spent on the jobs. The worker worked on the three bundled

jobs for a total of six hours. Therefore, the salary cost is 6 × USD 12.00 = USD 72.00. When you use real-time

allocation, the cost per hour is recalculated by using the factor from the Net time formula. The actual time that

was spent on each job is then transferred together with the corrected cost price per hour. In the example, six

hours are spent, although 10 hours were allocated. The following table illustrates the formula for calculating

cost. Here is the formula: Cost per hour = (Total bundle time per job (Net time) ÷ Actual time per job) ×

Standard cost price per hour

The corrected cost per hour and the job time are posted in a production journal. Note:Note: If you select the CostCost

categor ycategor y  option on the GeneralGeneral  tab on the Production order defaultsProduction order defaults  page, the actual time for each job is

transferred to a production journal, where the cost is applied to the cost category of the specific job.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Calculate material consumption
2/18/2021 • 3 minutes to read • Edit Online

Variable and constant consumption

Calculating consumption from a formula

Rounding up and multiples

QuantityQuantity

MeasurementMeasurement

This article provides information about various options that are related to the calculation of material

consumption.

The following options that are related to the calculation of material consumption are available on the SetupSetup and

Step consumptionStep consumption tabs on the L ine detailsL ine details  FastTab of the Bill of mater ialsBill of mater ials  page.

In the Consumption isConsumption is  field, you can select whether consumption should be calculated as a constant quantity

or a variable quantity. Select ConstantConstant if a fixed quantity or volume is required for the production, regardless of

the quantity that is produced. Select Var iableVariable, which is the default setting, if the required amount of material in

the finished goods is proportional to the number of finished goods that are produced.

In the FormulaFormula field, you can set up various formulas for calculating material consumption. If you use the

default value, StandardStandard, the consumption isn't calculated from a formula. The following formulas work together

with the HeightHeight, WidthWidth, DepthDepth, DensityDensity , and ConstantConstant fields:

Height * Constant

Height * Width * Constant

Height * Width * Depth * Constant

(Height * Width * Depth / Density) * Constant

Together, the Rounding upRounding up and MultiplesMultiples  fields let you round up the material consumption value. For

example, you can round up the value according to the handling unit in which the raw material is picked for

production. The following options are available in the Rounding upRounding up field: QuantityQuantity , MeasurementMeasurement, and

ConsumptionConsumption.

If you select QuantityQuantity  as the rounding-up mechanism, the quantity must be a multiple of the specified quantity.

For example, if whole numbers are required, select 11  in the MultiplesMultiples  field. Numbers are then rounded up to a

quantity that is divisible by 1.

Typically, you select MeasurementMeasurement as the rounding-up mechanism when the raw material comes in specific

dimensions. For example, a piece of 2-meter metal tube is required for a finished good, and the metal tube is

stored in 4.5-meter lengths. In this case, the MeasurementMeasurement rounding-up mechanism can be used to calculate

how many metal tubes are required to produce a specific number of pieces of the finished good. For this

example, the FormulaFormula field is set to Height * ConstantHeight * Constant. The HeightHeight field is set to 22  to indicate the length of

the tube that is required for the finished good. The MultipleMultiple field is set to 4.54.5  to indicate that the tube is picked

in lengths of 4.5 meters. Here is the calculation:

1. Number of multiples that are required for 10 pieces of the finished good: 10 ÷ 2 = 5 pieces

2. Total consumption: 4.5 × 5 = 22.5 meters of metal tube

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/consumption.md


ConsumptionConsumption

Step consumption

F RO M  SERIESF RO M  SERIES Q UA N T IT YQ UA N T IT Y

0.00 10.0000

100.00 20.0000

200.00 40.0000

NOTENOTE

It's assumed that 0.5 meter of tube is scrapped for every five pieces of tube that are consumed.

Typically, you select ConsumptionConsumption as the rounding-up mechanism when raw material must be picked in whole

quantities of a specific handling unit of the product. For example, 2 quarts of paint are used to produce one

piece of a finished good, and the paint is picked in 25-quart cans. In this case, the ConsumptionConsumption rounding-up

mechanism can be used to round up consumption to whole numbers of 25-quart cans. Here is the calculation

for the amount of paint that is required if 180 pieces of the finished good must be produced:

1. Paint that is required, excluding scrap: 180 × 2 = 360 quarts

2. Number of cans: 360 ÷ 25 = 14.4, which is rounded up to 15

3. Paint that is required, including scrap: 15 × 25 = 375 quarts

Step consumption is used to calculate constant consumption in quantity intervals. If you select StepStep

consumptionconsumption in the FormulaFormula field on the SetupSetup tab, you can add information about the steps on the StepStep

consumptionconsumption tab. The fixed consumed quantity can be set up in intervals of the produced quantity. For

example, step consumption is set up as shown in the following table.

The bill of materials (BOM) quantity is 1, and the production quantity is 110. The formula for the consumption is

From series (Quantity) = Consumption. Because the production quantity is 110, it falls into the "From 100

series." Therefore, the quantity is 20.
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Production posting
2/18/2021 • 3 minutes to read • Edit Online

Material consumption

Time consumption

Reporting finished goods and error quantities

Ending the production order

Controlling the level of ledger posting

This article provides information about different types of postings in the production process.

Production posting activities follow production processes that are described in the sections below.

Materials are registered as consumed during production when the production picking list journal is posted. This

process generates issue transactions that deduct the on-hand inventory. In the production parameters, you can

specify whether the value of raw materials that are in progress (work in process [WIP]) should be posted in the

ledger. The value of raw materials that are in progress (WIP) is then posted to a dedicated Picking list account

and a dedicated Picking list offset account.

The time that workers spend on production jobs is recorded in the Route card journal or the Job card journal.

When these journals are posted, ledger posting to a dedicated account for resources that are in progress (WIP)

is processed. This posting represents the value of the time that is spent on the production order. After the

production order is registered as ended, the WIP accounts are settled.

When a production order is reported as finished, the quantity of the finished goods that have been completed is

updated in Inventory management through the Report as finished journal. If you're using WIP accounting, which

can be set up in the production parameters, a ledger journal is made to reduce the WIP accounts and increase

the inventory of the finished goods. The journal uses the standard cost that is defined for the product.

Before a production order is ended, actual costs are calculated for the quantity that was produced. All estimated

costs of material, labor, and overhead are reversed and replaced with actual costs. The overall cost of the

finished item is debited from the inventory Receipt account and credited to the inventory Issues account. If you

select the End jobEnd job check box when you run the cost calculation, the status of the production order is changed to

EndedEnded. This status prevents any additional costs from being unintentionally posted to a completed production

order. You can specify that the value of error quantities that are reported during reporting as finished should be

allocated to the good quantities that are reported as finished. Alternatively, you can specify that the value of

error quantities should be posted to a dedicated scrap account.

In the Production control parametersProduction control parameters , you can use the Ledger postingLedger posting field to set the level of ledger

posting for production processes. The following values are available:

Item and resourceItem and resource – Use the ledger accounts that are set up on the item groups for raw materials and

finished goods. WIP for time consumption is taken from resource or resource group from the route

operations.

Item and categor yItem and categor y  – Use the ledger accounts that are set up on the item groups for raw materials and

finished goods. WIP for time consumption is taken from the cost categories that are associated with the route
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NOTENOTE

operations.

Production groupsProduction groups  – Use the ledger accounts that are set up on the production groups for both material

and time consumption. The production groups are associated with the released products and copied to the

production orders when those orders are created. The posting on the production orders will then follow the

production groups that are associated with the production order.

Note:Note: If the standard method for calculating the cost of the finished item was used, the final transactions reflect

this fact. If actual costs and the costs that are calculated by using the standard method differ, the difference is

posted to the account that shows profit or loss.
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Time and attendance registration overview
2/18/2021 • 6 minutes to read • Edit Online

Registrations

N OT EN OT E

If you run Time and attendance together with Manufacturing execution, all registrations on projects, project activities, indirect
activities, absence codes, and overtime and flex time will be recorded and are used to calculate payroll in both modules.

Time registrations workers

N OT EN OT E

A worker can be automatically assigned the time registrations that are made on a particular machine on the shop floor, if the
worker chooses to work as an assistant to the machine when he or she starts the production job.

Time registration workers can enter different types of time registrations, for example, clock in, clock out, register

indirect activities, and absence registration. This topic describes registrations, their calculation, approval, and the

use of workflow to add structure and automated approval to the process of approving timesheets.

In companies that use Time and attendance, workers must register the time that they spend at work, as well as

their attendance. Some companies may only require workers to register clocking-in and clocking-out times. In

other companies, workers may also be required to register time consumption on the actual activities they

perform as well as the breaks they take. The intended users of Time and attendance are:

Workers, who are required to register time and attendance at regular intervals, for example daily, weekly or

bi-weekly.

Supervisors, managers, and payroll officers who calculate, approve, and transfer worker registrations for

further processing.

To be able to register time and absence, workers must be set up as time registration workers in the company

they are employed in.

After setup, the workers can enter different types of registrations.

Clocking in- and out when arriving or leaving work.

Time and item consumption on production jobs.

Time used on a machine on the shop floor, if the machine has been defined as a resource.

Time registrations on projects and project activities.

Registering project fees and item consumption via the respective project fee journals and project item

journals.

Planned absence.

Absence when arriving late to work or leaving earlier than planned.

Work breaks, either manually registered or automatically calculated by the system.

Indirect activities, which are non-productive activities a worker might engage in during a workday. Examples

of these activities include meetings or cleaning their workspace.

Overtime, which can be registered either as extra hours, flextime, or overtime.
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Adding clock-out registrations

Calculating registrations

Approving registrations

N OT EN OT E

If overtime has been calculated for specific workers, the overtime can be allocated to specific jobs during the day. This is
relevant if job cost is calculated based on worker pay.

Approving registrations using workflow

If a worker forgets to clock-out at the end of their workday, the missing registration can be added by running a

batch job. The system will compare the clock-in time and the clock-out time according to the associated profile

of the worker, and automatically insert the missing clock-out registration to match the profile’s end time. Both

the clock-in and clock-out registrations are vital for the subsequent calculation and approval of time

registrations before they can be transferred to payroll.

When a registration worker is assigned a calculation group that typically relates to a specific team, shift, or work

group. The team manager or supervisor typically validates the registrations made by the workers, and is

therefore also the responsible person to run the calculation for the respective calculation groups on a daily

basis. As part of the calculation process the team manager or supervisor is able to:

Correct erroneous registrations. For example, change switch codes and adjust feedback on production jobs.

Add missing registrations. For example, create clock-out registrations and create absence transactions.

Delete incorrect registrations.

Because the registered time must match the worker ’s time profile prior to calculating the registrations, you must

override the work time profile for any worker who has an exception to his standard work time profile. In the

case, where the worker profile is day shift, and the worker has agreed to work a night shift with no overtime pay,

the team manager or supervisor must override the default worker profile in order to calculate the working time

at the standard night rate and not as overtime. The calculation will also display an error if an absence

registration is missing. It must be added before the calculation can be completed.

Just as you assign a calculation group to a time registration worker, you must assign an approval group as well.

Typically the group will be specific to a team, shift, or work group. You must approve the time registrations that

were calculated correctly – this means doing a calculation without errors – before pay items can be generated

that afterward can be transferred to a payroll system. The payroll administrator will typically do the approval of

registrations, and prior to the approval he is able to:

Override pay agreements for individual workers.

Add manual premiums.

Enter additional information about absence registrations.

You can set up a workflow approval process that automatically approves registrations which comply with

workflow rules, leaving only deviations to be handled manually. If workflow approval is activated, the team

manager or supervisor submits the calculated registrations for approval. The workflow process will generate the

appropriate approvals and tasks, and then assign them to the right users and roles as identified in the workflow.

There are two workflow approvals for time and attendance.



W O RKF LO WW O RKF LO W P URP O SEP URP O SE REGIST RAT IO N  T Y P EREGIST RAT IO N  T Y P E

Time and attendance days total The workflow validates registrations
against, for example, the expected
number of work hours for the day.

Time and attendance journal
registration.

The workflow validates each
registration type for the date of the
registration.

Time and attendance • Clock-in •
Clock-out • Absence • Break • Switch
code • Project • Project activity •
Indirect activity Production jobs •
Queue before • Setup • Process •
Overlap • Transport • Queue after •
Start assistance • Stop assistance

Transferring approved registrations

Reversing transferred registrations

N OT EN OT E

The external file can be imported into a payroll system.

Registrations in electronic timecards

NOTENOTE

After approval of the registrations you can transfer them to a periodic payroll job. A transferred registration is

posted to an activity or job that it relates to, for example, a production order or a project. Payroll transactions are

generated for each worker based on the registrations.

The task of reversing transactions – rolling them back – can be done until the time when the payroll period’s pay

transfer is run. This means that payroll data has been transferred to an external file. When reversed, all

registrations are withdrawn, and any transactions posted on production orders or projects are offset and

neutralized.

Workers with job tasks that do not require immediate feedback, as is the case with production jobs, but who

work on project activities, can benefit from using the electronic timecard. Electronic timecards offer the flexibility

to enter registrations any time and in the best way for your business schedule – daily, weekly, or when a worker

is in the office again after being away. To use electronic timecards or these workers, you must specify, Use

timecard, in the worker details. Electronic timecards enable the worker to register :

Date

Registration type

Job reference, such as project, indirect activity, or production order

Job identification

Time consumption

Project fees

Project items
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Pay based on registrations
2/18/2021 • 27 minutes to read • Edit Online

The use of flex time

Scenarios based on flex periods

Flex profile for one workdayFlex profile for one workday

P RO F IL E  T Y P EP RO F IL E  T Y P E STA RTSTA RT EN DEN D DAYDAY

Over time 00:00 AM 06:00 AM Monday

Flex+ 06:00 AM 07:00 AM Monday

Clock in 07:00 AM 07:00 AM Monday

Standard time 07:00 AM 02:30 PM Monday

Flex- 02:30 PM 03:30 PM Monday

Clock out 03:30 PM 03:30 PM Monday

Over time 03:30 PM 06:00 AM Tuesday

Scenario 1: A worker registers clock-in during a Flex+ period and clock-out during a Flex- periodScenario 1: A worker registers clock-in during a Flex+ period and clock-out during a Flex- period

This topic explains, in detail, how pay is calculated based on worker registrations. It includes examples that show

how the various combinations of setup options that are available for the calculation affect the result. Here are

some of the areas that will be covered:

Flex time

Overtime

Breaks

Switch codes

Pay items

Pay agreements

Time and attendance calculation parameters

Absence

Periods of flex time are set up in the time profiles that are used in Time and attendance. There are two flex

profile types: Flex+Flex+ and Flex-Flex-. When a worker registers time in a Flex+ period, the worker's flex balance is

increased by the hours that were worked. The worker doesn't receive any compensation for the hours that were

worked during the Flex+ period. However, the worker can take time off during the Flex- periods and be

compensated with the hours from his or her flex balance. Therefore, time off during the flex periods is

considered an absence by the system.

The two scenarios that follow are based on a flex profile that represents a workday. For both scenarios, pay is

calculated according to the flex period where the worker clocks in and out.
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JO URN A L  REGIST RAT IO N  T Y P EJO URN A L  REGIST RAT IO N  T Y P E STA RTSTA RT EN DEN D

Clock in 06:30 AM 06:30 AM

Production job 06:30 AM 02:45 PM

Clock out 02:45 PM 02:45 PM

F L EX  +F L EX  + F L EX  -F L EX  - T IM ET IM E PAY  T IM EPAY  T IM E

0.50 0.75 8.25 8.50

Calculation of Flex+Calculation of Flex+

Calculation of Flex-Calculation of Flex-

Calculation of TimeCalculation of Time

Calculation of Pay timeCalculation of Pay time

T IM ET IM E REGIST RAT IO N  T Y P EREGIST RAT IO N  T Y P E PAY  T IM E ( H O URS)PAY  T IM E ( H O URS)

6:30 AM - 7:00 AM Flex+ 0

7:00 AM – 2:45 PM Standard time 7.75

2:45 PM – 3:30 PM Flex- 0.75 (Absence period)

Total 8.50

Scenario 2: A worker works during the whole Flex- period and also works overtimeScenario 2: A worker works during the whole Flex- period and also works overtime

The worker's registrations for the day looks like this.

The worker's registrations for the day are calculated and transferred to pay on the ApproveApprove page (Time andTime and

attendanceattendance > Review and approveReview and approve > ApproveApprove). After the registrations have been calculated, the result of the

calculation can be viewed on the TimesTimes  tab.

To understand this scenario, see the following fields.

According to the flex profile, the time between 06:00 AM and 07:00 AM is a Flex+ period. Therefore, if the

worker clocks in at 06:30 AM, he earns 0.5 hours. This amount of time is added to the worker's flex account.

According to the flex profile, the Flex- period starts at 02:30 PM and ends at 03:30 PM. Therefore, if the worker

clocks out at 02:45 PM, the 45 minutes (0.75 hours) that remain in the Flex- period are registered as pay time,

and the same amount of time is deducted from the worker's flex account. The 45 minutes are included in pay

time because the worker will be granted pay for the remaining 45 minutes in the Flex- period. If the worker is

absent during the Flex- period, the 45 minutes will be deducted from his flex account.

Time is calculated as the time between clock-in and clock-out, that is, 06:30 AM to 14:45 PM with equals 8.25

hours.

Pay time is the time that a worker is granted pay during. In this scenario, the worker is at work for 8.25 hours

(TimeTime). However, Pay timePay time is calculated as 8.50 hours because the worker is granted pay during the Flex-

period after he clocked out. The pay time equals the planned work hours because Flex+ time is added to the

worker's flex account, not to the pay time. The absence time during the Flex- period is compensated for by the

pay time and deducted from the worker's flex account.

The worker's registrations for the day look like this.



JO URN A L  REGIST RAT IO N  T Y P EJO URN A L  REGIST RAT IO N  T Y P E STA RTSTA RT EN DEN D

Clock in 06:30 AM 06:30 AM

Production job 06:30 AM 05:00 PM

Clock out 05:00 PM 05:00 PM

F L EX  +F L EX  + F L EX  -F L EX  - T IM ET IM E PAY  T IM EPAY  T IM E PAY  O VERT IM EPAY  O VERT IM E

0.50 0.00 10.50 10.00 1.50

Calculation of Flex+Calculation of Flex+

Calculation of Flex-Calculation of Flex-

Calculation of TimeCalculation of Time

Calculation of Pay timeCalculation of Pay time

Calculation of Pay overtimeCalculation of Pay overtime

T IM ET IM E REGIST RAT IO N  T Y P EREGIST RAT IO N  T Y P E PAY  T IM E ( H O URS)PAY  T IM E ( H O URS)

6:30 AM - 7:00 AM Flex+ 0

7:00 AM – 2:30 PM Standard time 7.50

2:30 PM – 3:30 PM Flex- 1.00

3:30 PM – 05:00 PM Overtime 1.50

Total 10.00

Generation of pay itemsGeneration of pay items

After you've calculated the journal registrations on the ApproveApprove page, you can view the calculation result on the

TimesTimes  tab. To understand this scenario, see the following fields.

According to the flex profile, the time between 06:00 AM and 07:00 AM is a Flex+ period. Therefore, if the

worker clocks in at 06:30 AM, she earns 0.5 hours of Flex+ time on her flex balance.

Because the worker is working during the Flex- period, Flex- isn't calculated. Flex- is calculated only if the worker

is absent during the Flex- period. From a payment perspective, if the worker works during the Flex- period, she

is granted the pay rate that is defined for standard time. If the worker if is absent during the Flex- period, the 45

minutes are deducted from her flex account.

Time is calculated as the time between clock-in at 06:30 AM and clock-out at 05:00 PM, or 10.50 hours.

In this scenario, the worker works 10.50 hours (TimeTime). However, Pay timePay time is calculated as 10.00 hours because

the worker isn't granted pay during the Flex+ period.

Worker registrations for the day can be transferred from the ApproveApprove page. During the transfer process, pay

items and transferred registrations are generated. Pay items represent a breakdown of pay time into standard

time, overtime, paid break time, and so on.

To open the list of pay items, select Time and attendanceTime and attendance > Review and approveReview and approve > ApproveApprove. Then select

Inquir yInquir y  > Transferred registrationsTransferred registrations .

The pay items are the basis for a worker's pay. You can generate a file that includes the information from the pay

items and transfer that file to a payroll system.



WA GE T Y P EWA GE T Y P E PAY  T Y P EPAY  T Y P E PAY  UN IT SPAY  UN IT S RAT ERAT E TOTA L  C O STTOTA L  C O ST

Standard time 1201 10.0 10 100

Overtime 1301 1.50 5 7.50

Total 107.50

Exclude overtime from the standard timeExclude overtime from the standard time

REG.REG.
SP EC IF IC AT IO NSP EC IF IC AT IO N

P RO F IL EP RO F IL E
SP EC IF IC AT IO NSP EC IF IC AT IO N
T Y P ET Y P E C A L C UL AT IO NC A L C UL AT IO N PA IDPA ID

Working time Overtime Standard time Yes Pay time No

Pay time Yes Pay overtime Yes

WA GE T Y P EWA GE T Y P E PAY  T Y P EPAY  T Y P E PAY  UN IT SPAY  UN IT S RAT ERAT E TOTA L  C O STTOTA L  C O ST

Standard time 1201 8.50 10 85.0

Overtime 1301 1.50 15 22.50

Total 107.50

As part of the transfer process, time and cost from production and project activities are transferred to

production and project journals to account for the time and cost spend. The transferred registrations are the

basis for time and cost price per hour for production orders and projects. You can open the transferred

registrations by using the Inquir yInquir y  menu on the ApproveApprove page.

For example, for scenario 2, the following pay items are generated.

The pay item for standard time has a pay unit of 10 hours that covers standard time, Flex- time, and overtime.

Standard time, Flex- time, and overtime are consolidated into one pay item because all the types are calculated

as standard time, based on the default setting of a parameter on the Calculation parametersCalculation parameters  page (Time andTime and

attendanceattendance > SetupSetup > Calculation parametersCalculation parameters ). The overtime is calculated on top of the standard time by

using an additional rate of 5.

If you want to clearly distinguish standard time and overtime, so that the pay units for the pay types cover only

the actual time spend on standard time and overtime, the pay units for standard time must be calculated as

8.50, and the pay units for overtime must be calculated as 1.50.

To configure the system to clearly distinguish standard time and overtime, you must exclude overtime from the

standard time. You must also change the setup of the pay type for overtime so that the pay rate for overtime

covers all payments for the hours that were spent on overtime.

On the Calculation parametersCalculation parameters  page, select Over timeOver time as the profile specification type, and set the Pay timePay time

option to NoNo, as shown here.

After you adjust the calculation parameters, the following pay items are generated.



NOTENOTE

Allow a deviation from the standard pay profilesAllow a deviation from the standard pay profiles

Switch codesSwitch codes

P RO F IL E  T Y P EP RO F IL E  T Y P E STA RTSTA RT EN DEN D DAYDAY

Over time 00:00 AM 06:00 AM Monday

Flex+ 06:00 AM 07:00 AM Monday

Clock in 07:00 AM 07:00 AM Monday

Standard time 07:00 AM 02:30 PM Monday

Flex- 02:30 PM 03:30 PM Monday

Clock out 03:30 PM 03:30 PM Monday

Over time 03:30 PM 06:00 AM Tuesday

JO URN A L  REGIST RAT IO N  T Y P EJO URN A L  REGIST RAT IO N  T Y P E STA RTSTA RT EN DEN D

Clock in 06:30 AM 06:30 AM

Production job 06:30 AM 02:45 PM

Clock out 05:00 PM 05:00 PM

The calculation parameters have a recommended standard setting. In general, you should be careful when you change

these parameters. To restore the recommended standard settings, on the Calculation parametersCalculation parameters  page, select RestoreRestore

valuesvalues .

On the ProfilesProfiles  page (Time and attendanceTime and attendance > SetupSetup > Time profilesTime profiles  > ProfilesProfiles ), you can set up profile

types that include switch codes and breaks.

You can use switch codes to allow workers to deviate from their profile type by changing a different profile type.

For example, you can allow a worker to change from Flex+ time to overtime. A worker can add a switch code

during registration, or you can assign the task of adding a switch code to the approver of the registrations.

Before a switch code can be used, you must define it as a type of indirect activity. You must then add the switch

code to the time profile for the period where you want to allow a change of profile type. For example, follow

these steps to create a switch code that allows the Flex+ period to be changed from 06:00 AM to 07:00 AM to

overtime.

1. Create a switch code that is named OTBCI (Conver t flex to over time before clock-in)OTBCI (Conver t flex to over time before clock-in) . Select Time andTime and

attendanceattendance > Manage indirect activitiesManage indirect activities  > Indirect activitiesIndirect activities .

2. In the Switch codeSwitch code column, add OTBCI to the Flex+ line in the time profile.

3. In the Secondar ySecondar y  column, add the Over timeOver time profile type.

Consider the following flex profile that represents a workday.

Here are the worker's registrations for the day.



WA GE T Y P EWA GE T Y P E PAY  T Y P EPAY  T Y P E PAY  UN IT SPAY  UN IT S RAT ERAT E TOTA L  C O STTOTA L  C O ST

Standard time 1201 8.50 10 85.0

Overtime 1305 1.50 15 22.50

Total 107.50

WA GE T Y P EWA GE T Y P E PAY  T Y P EPAY  T Y P E PAY  UN IT SPAY  UN IT S RAT ERAT E TOTA L  C O STTOTA L  C O ST

Standard time 1201 8.50 10 80.0

Overtime 1305 2.00 15 30.0

Total 107.50

NOTENOTE

BreaksBreaks

Planned breaksPlanned breaks

Registered breaksRegistered breaks

Paid and unpaid breaksPaid and unpaid breaks

Example of a planned breakExample of a planned break

P RO F IL E  T Y P EP RO F IL E  T Y P E STA RTSTA RT EN DEN D DAYDAY

Over time 00:00 AM 06:00 AM Monday

The following pay items are generated after the transfer.

On the ApproveApprove page, undo the transfer, and then use the Switch codeSwitch code menu to apply the OTBCIOTBCI switch code.

When you transfer the registrations a second time, the following pay items are generated.

When you apply the switch code, overtime is increased by 0.5 hour, from 1.50 to 2.00. The 0.5 hour is the conversion of

the Flex+ time that is registered, from 6:30 AM to 07:00 to overtime.

Breaks from work affect the calculation of worker pay. Breaks are defined as a type of indirect activity. They can

be defined as either PaidPaid, to allow the break to add to the worker's pay, or UnpaidUnpaid, to prevent the break from

adding to the worker's pay. A break can also be defined as either PlannedPlanned or RegisteredRegistered.

If a company has a fixed break time, such as a fixed break for lunch, the break can be predefined in the time

profile. In this case, the worker doesn't have to register the break on the job card pages. Instead, the break is

automatically accounted for when the worker's registrations are calculated on the ApproveApprove page.

If a company doesn't use planned breaks, workers can register breaks during the workday. Registered breaks

can be used, for example, if a worker is working against a flex time profile that has no defined clock-in and clock-

out times. Registered breaks are a type of indirect activity. The worker registers the break on the Job cardJob card

terminal page or on the Job cardJob card device page. On both these pages, the user can select the type of break in a

list of predefined break activities.

Break activities can be set up as PaidPaid or UnpaidUnpaid. A paid break is included in the calculation of pay time, and the

system uses the pay type that is defined in the pay agreement for the BreakBreak registration type.

Consider the following time profile that includes an unpaid break for lunch.



Flex+ 06:00 AM 07:00 AM Monday

Clock in 07:00 AM 07:00 AM Monday

Standard time 07:00 AM 12:00 PM Monday

Break 12:00 PM 12:30 PM Monday

Standard time 12:30 PM 02:30 PM Monday

Flex- 02:30 PM 03:30 PM Monday

Clock out 03:30 PM 03:30 PM Monday

Over time 03:30 PM 06:00 AM Tuesday

P RO F IL E  T Y P EP RO F IL E  T Y P E STA RTSTA RT EN DEN D DAYDAY

JO URN A L  REGIST RAT IO N  T Y P EJO URN A L  REGIST RAT IO N  T Y P E STA RTSTA RT EN DEN D

Clock in 06:30 AM 06:30 AM

Production job 06:30 AM 02:45 PM

Clock out 05:00 PM 05:00 PM

F L EX  +F L EX  + F L EX  -F L EX  - T IM ET IM E PAY  T IM EPAY  T IM E
N O N - PA IDN O N - PA ID
B REA K  T IM EB REA K  T IM E PAY  O VERT IM EPAY  O VERT IM E

0.50 0.00 10.50 9.50 0.5 1.50

NOTENOTE

Example of a registered breakExample of a registered break

P RO F IL E  T Y P EP RO F IL E  T Y P E STA RTSTA RT EN DEN D DAYDAY

Over time 00:00 AM 06:00 AM Monday

Flex+ 06:00 AM 07:00 AM Monday

Clock in 07:00 AM 07:00 AM Monday

Standard time 07:00 AM 02:30 PM Monday

Here are the worker's registrations for the day.

After you've calculated the journal registrations on the ApproveApprove page, you can view the calculation result on the

TimesTimes  tab. To understand this scenario, see the following fields.

The system calculated 0.5 hours of unpaid break time, and that time isn't part of the pay time.

Consider the following time profile that doesn't include planned breaks.



Flex- 02:30 PM 03:30 PM Monday

Clock out 03:30 PM 03:30 PM Monday

Over time 03:30 PM 06:00 AM Tuesday

P RO F IL E  T Y P EP RO F IL E  T Y P E STA RTSTA RT EN DEN D DAYDAY

JO URN A L  REGIST RAT IO N  T Y P EJO URN A L  REGIST RAT IO N  T Y P E STA RTSTA RT EN DEN D

Clock in 06:30 AM 06:30 AM

Production job 06:30 AM 05:00 PM

Break 12:03 PM 12:32 PM

Clock out 05:00 PM 05:00 PM

JO URN A L  REGIST RAT IO NJO URN A L  REGIST RAT IO N
T Y P ET Y P E STA RTSTA RT EN DEN D T IM ET IM E

Clock in 06:30 AM 06:30 AM

Production job 06:30 AM 05:00 PM 10.00

Break 12:03 PM 12:32 PM 0.50

Clock out 05:00 PM 05:00 PM

NOTENOTE

F L EX  +F L EX  + F L EX  -F L EX  - T IM ET IM E PAY  T IM EPAY  T IM E
N O N - PA IDN O N - PA ID
B REA K  T IM EB REA K  T IM E PAY  O VERT IM EPAY  O VERT IM E

0.50 0.00 10.50 9.50 0.5 1.50

Here are the worker's registrations for the day.

When the registrations are calculated, the time for the activities is calculated.

The time for the break runs in parallel with the time for the activity (a production job, in this example). This behavior is

always used for break activities. When the registrations are calculated, the break time is subtracted from the activity time.

In this case, the production job has a duration of 10.50 hours, but the time is calculated as 10 because 0.5 hours of break

time are subtracted from the activity time.

After you've calculated the journal registrations on the ApproveApprove page, you can view the calculation result on the

TimesTimes  tab. To understand this scenario, see the following fields.

If the planned break had been paid instead of unpaid, the calculation result would look like this.



F L EX  +F L EX  + F L EX  -F L EX  - T IM ET IM E PAY  T IM EPAY  T IM E
PA ID B REA KPA ID B REA K
T IM ET IM E PAY  O VERT IM EPAY  O VERT IM E

0.50 0.00 10.50 10.00 0.5 1.50

Pay items and paid breaksPay items and paid breaks

P RO F IL E  T Y P EP RO F IL E  T Y P E STA RTSTA RT EN DEN D DAYDAY

Over time 00:00 AM 06:00 AM Monday

Flex+ 06:00 AM 07:00 AM Monday

Clock in 07:00 AM 07:00 AM Monday

Standard time 07:00 AM 02:30 PM Monday

Flex- 02:30 PM 03:30 PM Monday

Clock out 03:30 PM 03:30 PM Monday

Over time 03:30 PM 06:00 AM Tuesday

JO URN A L  REGIST RAT IO NJO URN A L  REGIST RAT IO N
T Y P ET Y P E STA RTSTA RT EN DEN D T IM ET IM E

Clock in 07:00 AM 07:00 AM

Production job 07:00 AM 03:00 PM 7.5

Break (Paid) 12:00 PM 12:30 PM 0.5

Clock out 03:00 PM 03:00 PM

WA GE T Y P EWA GE T Y P E PAY  T Y P EPAY  T Y P E PAY  UN IT SPAY  UN IT S RAT ERAT E

Standard time 1201 7.50 10

Flex- 1201 0.50 10

Break (Paid) 1301 0.50 8

When you transfer registrations on the ApproveApprove page, pay items are generated. A separate pay item is

generated for paid breaks.

The pay rate for a paid break is determined by the pay type that is set up in the pay agreements for the break.

Instead of using a pay type, you can set up the cost price per hour on the break for a defined date interval.

Consider the following time profile.

Here are the worker's registrations for the day.

For this example, the pay type for standard time is set to 12011201 , and a pay rate of 1010  is set up in the pay

agreement. The paid break has a pay type of 13011301  and a pay rate of 88 . When the registrations are transferred,

the following pay items are generated.



How the cost of paid breaks is allocated to projects and production
orders

Cost calculation based on pay rates that are calculated in Time and attendanceCost calculation based on pay rates that are calculated in Time and attendance

JO URN A L  REGIST RAT IO NJO URN A L  REGIST RAT IO N
T Y P ET Y P E STA RTSTA RT EN DEN D T IM ET IM E

Clock in 07:00 AM 07:00 AM

Process (Order: 4711) 07:00 AM 11:00 AM 4

Process (Order: 4712) 11:00 AM 03:00 PM 3.50

Break (Paid) 12:00 PM 12:30 PM 0.50

Clock out 03:00 PM 03:00 PM

REGIST RAT IO N  T Y P EREGIST RAT IO N  T Y P E T IM ET IM E C O ST  P RIC E  P ER H O URC O ST  P RIC E  P ER H O UR

Clock-in 0.00 0.00

Process (Order: 4711) 4.00 10.00

Process (Order: 4712) 3.50 11.14

Break (Paid) 0.50 0.00

Clock out 0.00 0.00

The hourly cost on project activities and production jobs can be set up so that it's determined either by the pay

rates that are calculated in Time and attendance or by the cost categories that are defined for the activities.

To set up the cost category, select Production controlProduction control  > SetupSetup > Manufactur ing executionManufactur ing execution > ProductionProduction

order defaultsorder defaults , and set the Cost categor yCost categor y  field to either YesYes  or NoNo.

NoNo – Cost is calculated based on pay rates that are defined for Time and attendance registration types.

YesYes  – Cost is calculated based on cost categories for production and project activities.

The following example shows how the hourly cost is calculated when the cost is set up so that it's calculated

based on pay rates.

The hourly cost rate that is used for production orders and projects is calculated during the transfer process. To

view the hourly rate per activity, open the ApproveApprove page in Time and attendance, and then select Inquir yInquir y  >

Transferred registrationsTransferred registrations . You can find the hourly cost rate per registration on the Cost pr icesCost pr ices  tab.

Consider the following registrations that use the same time profile as the previous example.

After the registrations are transferred, the following transferred registrations are generated.

The calculation of the cost price per hour for the paid break depends on a setting for the direct payroll costs.

Select Time and attendanceTime and attendance > SetupSetup > Time and attendance parametersTime and attendance parameters . On the Cost pr iceCost pr ice tab, under

Direct payroll costsDirect payroll costs , in the Standard timeStandard time field, you can select YesYes , NoNo, or AllocationAllocation.

YesYes  – This value is used for the preceding example. The cost is allocated to the production or project

activity that runs in parallel with the paid break activity. In the example, this activity is the production job



Absence

Planned absencePlanned absence

REGIST RAT IO N  T Y P EREGIST RAT IO N  T Y P E T IM ET IM E C O ST  P RIC E  P ER H O URC O ST  P RIC E  P ER H O UR

Clock-in 0.00 0.00

Process (Order: 4711) 4.00 10.53

Process (Order: 4712) 3.50 10.53

Break (Paid) 0.50 0.00

Clock out 0.00 0.00

REGIST RAT IO N  T Y P EREGIST RAT IO N  T Y P E T IM ET IM E C O ST  P RIC E  P ER H O URC O ST  P RIC E  P ER H O UR

Clock-in 0.00 0.00

Process (Order: 4711) 4.00 10.00

Process (Order: 4712) 3.50 10.00

Break (Paid) 0.50 0.00

Clock out 0.00 0.00

for order 4712. As you can see, the cost price per hour for the paid break is 0 (zero), and it's allocated to

the job that runs in parallel with the break.

The paid break has a duration of 0.5 hour, and the pay rate is 8. Therefore, the total cost for the paid break

is 4. The total cost is then allocated to the 3.5-hour process job. Therefore, the paid break contributes 1.14

per hour to the cost (4 ÷ 3.5 = 1.14).

AllocationAllocation – The paid break is equally distributed to the jobs that are registered for the day. If this value

is used for the preceding example, the following transferred registrations are generated.

The total process time for the two production jobs is 7.5 hours, and the total cost of the paid break is 4.

Therefore, the cost of the break is calculated as 0.53 (= 4 ÷ 7.5).

NoNo – The cost of the paid break doesn't increase the hourly cost of the process activities.

An absence code is used to register the period of a worker's absence. Like breaks and switch codes, an absence

code is a type of an indirect activity. Absence time can be either planned or registered, and absence can be either

legal or illegal. Examples of legal absence include a doctor's appointment, a seminar, or jury duty. Illegal absence

is absence that has no good reason, such as when a worker is late for work. Usually, legal absence doesn't cause

a deduction in a worker's pay, whereas illegal absence does cause a deduction.

You can create planned absence for workers on the Create planned absenceCreate planned absence page (Time and attendanceTime and attendance >

Create planned absenceCreate planned absence). There, the planned absence is registered as an absence job for a specified date and

time interval.

The job is based on a query. Therefore, you can create planned absence for multiple workers, such as workers

who belong to the same calculation group. If the planned absence is for a single worker, the registration can be



Registered absenceRegistered absence

Scenarios based on various combinations of work hour registrations

P RO F IL E  T Y P EP RO F IL E  T Y P E STA RTSTA RT EN DEN D DAYDAY

Over time 00:00 AM 06:00 AM Monday

Flex+ 06:00 AM 07:00 AM Monday

Clock in 07:00 AM 07:00 AM Monday

Standard time 07:00 AM 02:30 PM Monday

Flex- 02:30 PM 03:30 PM Monday

Clock out 03:30 PM 03:30 PM Monday

Over time 03:30 PM 06:00 AM Tuesday

Scenario 1: The worker clocks in later than plannedScenario 1: The worker clocks in later than planned

entered from either the AttendanceAttendance page or the Time registration workersTime registration workers  page.

To enter an absence registration from the AttendanceAttendance page, select Time and attendanceTime and attendance > Inquir ies andInquir ies and

repor tsrepor ts  > AttendanceAttendance > AttendanceAttendance, and then select Absence registrationAbsence registration.

To enter an absence registration from the Time registration workersTime registration workers  page, select Time and attendanceTime and attendance

> SetupSetup > Time registration workersTime registration workers , and then, on the TimeTime tab, under Time assignmentTime assignment, select

Absence registrationsAbsence registrations .

You can use the Planned absencesPlanned absences  report to see an overview of planned absences for workers. To open this

report, select Time and attendanceTime and attendance > Inquir ies and repor tsInquir ies and repor ts  > Absence repor tsAbsence repor ts  > Planned absencesPlanned absences .

In general, workers are considered absent if they aren't at work for any period between their planned clock-in

time and their planned clock-out time. If workers clock in later than planned, or if they clock out earlier than

planned, they are prompted to select an absence code to indicate the reason for the absence. An absence code

can be set up so that it's applicable to registration. Only applicable codes will be available for selection in the list.

The following scenarios show the pay items and entries for approval that are generated for workers based on

their registrations. All the scenarios are based on the following time profile.

The worker clocks in at 08:30 AM. Because his planned clock-in time is 07:00 AM, he is 1.50 hour late for work.

Because the 1.50 hour is considered absence time, the worker is prompted to select an absence code. The

worker leaves work at 03:30 PM, which is the planned clock-out time. When the worker's registrations are

calculated and approved, the absence registration, together with the absence code that the worker selected at

clock-in, appears for the time between 07:00 AM and 08:30 AM.

In the time profile, you can configure the Clock-inClock-in registration type so that there is a tolerance when workers

are late for work. For example, if you set up a tolerance of 5, the worker is prompted for an absence code only if

he clocks in later than 07:05 AM.

In this case, because the worker doesn't have a good reason for being late for work, he selects an absence code

that is defined for illegal absence. An absence code is considered applicable to illegal absence if the setting for

overtime deduction is enabled for the absence group that the absence code belongs to. To set the setting, select

Time and attendanceTime and attendance > SetupSetup > GroupsGroups  > Absence groupsAbsence groups , and then select the Deduct over timeDeduct over time check

box.



JO URN A L  REGIST RAT IO NJO URN A L  REGIST RAT IO N
T Y P ET Y P E STA RTSTA RT EN DEN D T IM ET IM E

Absence (illegal - late for
work)

07:00 AM 08:30 AM 1.5

Clock in 08:30 AM 08:30 AM

Production job 07:30 AM 03:30 PM 7.0

Clock out 03:30 PM 03:30 PM

WA GE T Y P EWA GE T Y P E PAY  T Y P EPAY  T Y P E PAY  UN IT SPAY  UN IT S RAT ERAT E

Standard time 1201 7.00 10

Scenario 2: The worker clocks out before the planned clock-out time during a standard-time periodScenario 2: The worker clocks out before the planned clock-out time during a standard-time period

JO URN A L  REGIST RAT IO NJO URN A L  REGIST RAT IO N
T Y P ET Y P E STA RTSTA RT EN DEN D T IM ET IM E

Clock in 07:00 AM 07:00 AM

Production job 07:00 AM 01:00 PM 4.0

Clock out 01:00 PM 01:00 PM

Absence (legal – doctor's
appointment)

01:00 PM 03:30 PM 3.5

WA GE T Y P EWA GE T Y P E PAY  T Y P EPAY  T Y P E PAY  UN IT SPAY  UN IT S RAT ERAT E

Standard time 1201 7.50 10

Scenario 3: The worker clocks out before the planned clock-out time during a Flex- periodScenario 3: The worker clocks out before the planned clock-out time during a Flex- period

Here is how the worker's registrations for the day appear on the ApproveApprove page after calculation.

Here is the resulting pay item after the registrations are transferred.

The worker clocks in at 07:00 AM and clocks out early at 01:00 PM. Because 01:00 PM is before planned clock-

out at 03:30 PM, and 01:00 AM is in a standard-time period, the worker is prompted to select an absence code.

The worker selects an absence code for a doctor's appointment, which is defined as legal absence. The pay rate

for legal absence is defined in the pay agreements for the AbsenceAbsence registration type (Time and attendanceTime and attendance >

SetupSetup > PayrollPayroll  > Pay agreementsPay agreements ).

Here is how the worker's registrations for the day appear on the ApproveApprove page after calculation.

Here is the resulting pay item after the registrations are transferred.

The worker clocks in at 07:00 AM and clocks out at 02:15 PM, which is in the planned Flex- period. The time

between the actual clock-out time and the planned clock-out time isn't considered absence, and the worker isn't

prompted to select an absence code. The amount is deducted from the worker's flex account, and the worker is

granted pay during the remaining part of the Flex- period, from 02:15 to 03:30 PM.

Here is how the worker's registrations for the day appear on the ApproveApprove page after calculation.



JO URN A L  REGIST RAT IO NJO URN A L  REGIST RAT IO N
T Y P ET Y P E STA RTSTA RT EN DEN D T IM ET IM E

Clock in 07:00 AM 07:00 AM

Production job 07:00 AM 02:15 PM 7.25

Clock out 02:15 PM 02:15 PM

WA GE T Y P EWA GE T Y P E PAY  T Y P EPAY  T Y P E PAY  UN IT SPAY  UN IT S RAT ERAT E

Standard time 1201 8.50 10

Scenario 4: The worker clocks in late and clocks out after the planned clock-out time during an overtimeScenario 4: The worker clocks in late and clocks out after the planned clock-out time during an overtime
periodperiod

JO URN A L  REGIST RAT IO NJO URN A L  REGIST RAT IO N
T Y P ET Y P E STA RTSTA RT EN DEN D T IM ET IM E

Absence (illegal - late for
work)

07:00 AM 09:30 AM 1.5

Clock in 09:30 AM 09:30 AM

Production job 09:30 AM 05:00 PM 7.5

Clock out 05:30 PM 05:30 PM

WA GE T Y P EWA GE T Y P E PAY  T Y P EPAY  T Y P E PAY  UN IT SPAY  UN IT S RAT ERAT E

Standard time 1201 9.00 10

Overtime 1301 0.5 15

Here is the resulting pay item after the registrations are transferred.

The worker clocks in late at 09:30 AM and then, to compensate for his late attendance, he works overtime and

clocks out at 05:00 PM. Because the worker came in late and compensated by working longer, the company

doesn't want to grant the worker overtime pay for the hours that he worked between the planned clock-out at

03:30 PM and his actual clock-out at 05:00 PM, even though this period is defined as overtime in the time

profile.

To handle this scenario, the absence code can be set up to reduce overtime hours by any hours of illegal absence

that the worker has on the same day. Select Time and attendanceTime and attendance > SetupSetup > GroupsGroups  > Absence groupsAbsence groups ,

and select the Deduct over timeDeduct over time check box to deduct overtime from hours of illegal absence.

Here is how the worker's registrations for the day appear on the ApproveApprove page after calculation.

If the Deduct over timeDeduct over time check box is selected for the selected absence code, the overtime payment is deducted

by the hours that the worker was illegally absent. In this case, the following pay items are generated after the

registrations are transferred.

Here, the 1.5 hours of illegal absence, from 07:00 AM to 09:30 AM, deduct the 2.0 hours of overtime, from 03:30

PM to 05:30 PM. The result of the registration is 1.5 hours of standard time and 0.5 hours of overtime.

By contrast, if the Deduct over timeDeduct over time check box is cleared for the selected absence code, the overtime payment



WA GE T Y P EWA GE T Y P E PAY  T Y P EPAY  T Y P E PAY  UN IT SPAY  UN IT S RAT ERAT E

Standard time 1201 7.50 10

Overtime 1301 2.0 15

Scenario 5: The worker clocks out before the planned clock-out time and can convert the absence period to aScenario 5: The worker clocks out before the planned clock-out time and can convert the absence period to a
Flex- periodFlex- period

JO URN A L  REGIST RAT IO NJO URN A L  REGIST RAT IO N
T Y P ET Y P E STA RTSTA RT EN DEN D T IM ET IM E

Clock in 07:00 AM 07:00 AM

Production job 07:00 AM 01:00 PM 6.0

Clock out 01:00 PM 01:00 PM

WA GE T Y P EWA GE T Y P E PAY  T Y P EPAY  T Y P E PAY  UN IT SPAY  UN IT S RAT ERAT E

Standard time 1201 6.00 10

WA GE T Y P EWA GE T Y P E PAY  T Y P EPAY  T Y P E PAY  UN IT SPAY  UN IT S RAT ERAT E

Standard time 1201 8.50 10

is granted to the worker, even though he was late and had an illegal absence. In this case, the following pay

items are generated after the registrations are transferred.

The following example shows how a worker's flex account can be reduced by converting the absence period to a

Flex- period.

The worker clocks in at 07:00 AM and clocks out at 01:00 PM. She has reached an agreement with her

supervisor that she can go home for the weekend if she deducts these hours from her flex account. When the

worker clocks out at 01:00 PM, she is prompted to select an absence code, because the period of absence for the

remaining part of the workday that is affected isn't in a planned Flex- period. To convert the remaining part of

the workday to a Flex- period, the worker can select an absence code that is set up to reduce her flex account.

To reduce the balance of flexible hours for workers who register absence on a workday, select Time andTime and

attendanceattendance > SetupSetup > GroupsGroups  > Absence groupsAbsence groups , and select the Reduce flexReduce flex check box.

Here is how the worker's registrations for the day appear on the ApproveApprove page before calculation.

If the worker selects an absence code for illegal absence, here is how the resulting pay item will look after the

registration is transferred.

If the worker selects an absence code for legal absence, and the absence code is set up to reduce her flex

account, here is how the resulting pay items will look after the registrations are transferred.

In this case, the worker's flex balance is reduced by the hours between the actual clock-out time and the planned

clock-out time (that is, the 2.5 hours from 01:00 PM to 03:30 PM).



NOTENOTE

Scenario 6: There is no planned absence for the day and no worker attendance for the dayScenario 6: There is no planned absence for the day and no worker attendance for the day

NOTENOTE

We don't recommend that you select both the Deduct flexDeduct flex check box and the Deduct over timeDeduct over time check box for an

absence code, because this setup will deduct the illegal hours from the worker's overtime hours and at the same time

reduce the worker's flex account.

If the worker doesn't show up for work on a workday, and there is no planned absence for the worker on that

day, a default absence code is used for the calculation of the worker's registrations. To define default absence

codes, select Time and attendanceTime and attendance > Time and attendance parametersTime and attendance parameters . You can then select an absence

code in the following fields:

Auto insert Flex-

Auto insert absence

When the daily registrations are calculated for a worker who is enabled for flexible hours, the absence code that

is specified in the Auto inser t flex-Auto inser t flex- field is used as a default absence code. If the worker isn't enabled for

flexible hours, the absence code that is specified in the Auto inser t absenceAuto inser t absence field is used. If a company has a

combination of workers who are enabled for flexible hours and workers who aren't enabled for flexible hours,

both parameters must be set up.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Absence registration in Time and attendance
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Absence that is based on regular work hours

Absence codes

Set up standard time and flex timeSet up standard time and flex time

Absence groups

Planned absence

Set up planned absenceSet up planned absence

This topic describes the concepts for absence and explains how to handle absence in Time and attendance.

Workers are considered absent for any hours that they don't work during their regular work hours. Regular

work hours are defined in a worker's standard time profile.

For example, a worker is working on a day profile that has clock-in at 7:00 AM and clock-out at 3:00 PM. If the

worker clocks in at 9:00 AM, he is considered absent from 7:00 AM to 9:00 AM on that day.

In this case, workers are prompted to enter a reason for their absence. They can specify a reason by selecting an

absence code.

Absence codes define the various types of absence. Absence codes are defined by the company.

Various rules can be applied to absence codes. For example, an absence code can be configured to deduct or

grant pay.

For example, a company defines a LateLate absence code that workers use if they come in late and don't have a

good reason. The company also defines an Internal courseInternal course absence code that workers use for time that they

spend attending internal courses. These absence codes can be set up so that LateLate deducts from a worker's pay

but Internal courseInternal course doesn't deduct from a worker's pay.

You can set up automatic absence codes. These absence codes can be used to calculate a worker's time when no

absence is registered. The worker's time profile determines whether the absence code for standard time or flex

time is used.

Configure the parameters for standard time and flex time by using the Auto inser t absenceAuto inser t absence and AutoAuto

inser t Flex-inser t Flex- options on the Time and attendance parametersTime and attendance parameters  page.

Absence codes are grouped into absence groups. You use absence groups to group absence codes that have

common characteristics. Examples include absence codes for a legal absence, or absence because of a doctor's

appointment, jury duty, or a sick child.

If you know that a worker will be absent for a period, such as an upcoming vacation, you can use planned

absence. You set up planned absence by configuring the absence code so that it considers the planned absence.

When you set up a planned absence, you aren't prompted for an absence code during the absence period when

user time registrations are calculated. Planned absence can be defined for a single worker, or you can define a

batch job to bulk update the planned absence for workers.

1. Select Human resourcesHuman resources  > WorkersWorkers  > EmployeesEmployees , and select an employee.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/absence-registration-in-time-and-attendance.md


Interrupted planned absence

Set up a planned absence for interruptionSet up a planned absence for interruption

Examples of the use of absence in a flex profile
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8 AM 9 AM to
11:30 AM

11:30 AM to
12 PM

12 PM to 3
PM

3 PM to 4
PM

4 PM 4 PM to 6 PM

Example 1: Signing out during a Flex- periodExample 1: Signing out during a Flex- period

Example 2: Signing out in during Standard time periodExample 2: Signing out in during Standard time period

Example 3: Signing out during a Flex+ periodExample 3: Signing out during a Flex+ period

Absence in the calculation and approval process

2. Select TimeTime > Time assignmentsTime assignments  > Time Absence registrationTime Absence registration, and set up the planned absence.

If you apply the InterruptInterrupt option when you set up a planned absence, the planned absence will be interrupted if

the worker signs in during the planned absence period. The planned absence will be marked as InterruptedInterrupted

and won't have any effect on future calculations.

1. Open the Time Absence registrationTime Absence registration page as described in the procedure for setting up planned absence.

2. Select InterruptInterrupt.

The InterruptInterrupt option applies when time is registered through the shop floor terminal or the shop floor device.

The option doesn't apply if the registrations are entered on the calculation and approval pages, or on the

Electronic timecardElectronic timecard page.

The following three examples show how absence is calculated in a profile that has flex periods.

The examples use the following profile.

The worker clocks in at 8:00 AM and clocks out at 3:30 PM. In this case, because the worker clocks out during a

Flex- period, no absence is calculated, and half an hour is deducted from the worker's flex balance.

The worker clocks in at 8:00 AM and clocks out at 2:30 PM. In this case, because the worker clocks out during the

Standard time period, absence is calculated from 2:30 PM to 4 PM, and an absence period of 1.5 hours is

registered. An absence code for that period is required.

The worker clocks in at 8:00 AM and clocks out at 4:30 PM. In this case, because the worker clocks out during a

Flex+ period, no absence is calculated, and half an hour is added to the worker's flex balance.

Worker time registrations must be calculated and approved before they can be transferred to a payroll system

as pay items.

An approver can change a worker's time registrations. The approver can even change any absence that the

worker has registered. If the approver manually enters a time period that has an absence code, the absence code

for that period isn't overridden by the default absence code from the Time and attendance parameters.

For example, a worker clocks in at 10 AM and selects an absence code that indicates that she is late. Later, the

worker informs her supervisor that she had a doctor's appointment from 8 AM to 10 AM. A doctor's

appointment should not cause a deduction in the worker's pay. Therefore, in this case, the supervisor can adjust

the two hours of absence from 8 AM to 10 AM by manually entering an absence code that indicates illness for

those two hours.



Calculate and approve absenceCalculate and approve absence

NOTENOTE

Select Time attendanceTime attendance > Review and approveReview and approve > Approve or CalculateApprove or Calculate.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Set up flexible working hours in flex groups

Associate workers with flex groups

Rules for flex regulations

Flexible working hours let companies minimize payments for overtime by offering workers extra time off during

periods when the workload is low. This feature is relevant, for example, in segments that experience seasonal

changes in workload.

You can use flex groups to set the following rules and principles for a worker's flexible hours:

Rules for flex regulations

Principle for calculating the worker's flex balance

Select Time and attendanceTime and attendance > SetupSetup > GroupsGroups  > Flex groupsFlex groups  to set up flex groups for flexible hours.

Select Time and attendanceTime and attendance > SetupSetup > Time registration workersTime registration workers .

You can use rules for flex regulations to define flex limits, or the minimum and maximum number of hours that

are allowed in the worker's flex account. The flex limits are set up on the flex group. When the flex limits are

exceeded, a worker's flex balance and pay can be adjusted.

If a worker's allowed flex minimum is exceeded (that is, if the number of hours in the flex account is below the

specified minimum), you can use these methods to adjust the worker's flex balance by making a flex regulation:

The worker's flex account can be adjusted to the specified allowed minimum, but without deducting the

worker's pay for the number of hours that the flex account is below the allowed minimum.

The worker's pay can be deducted for the number of hours that the flex account is below the allowed

minimum. This deduction is done by generating pay items for a specific pay type that have a negative or

positive pay unit.

If the worker's allowed flex maximum is exceeded, you can use these methods to adjust the worker's flex balance

by making a flex regulation:

The worker's flex account can be adjusted back to the specified allowed maximum, but without compensating

the worker's pay for the number of hours that the worker worked above the allowed maximum.

The number of hours that the worker worked above the allowed maximum can be converted to pay. This

conversion is done by generating pay items for a specific pay type.

You can adjust a flex balance at the following times:

When a payment file that is based on payroll data is exported by using the Transfer payTransfer pay  job. The payroll

data is generated when you transfer the worker's registration from the ApproveApprove page.

When the Adjust flex balanceAdjust flex balance job is processed.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/time-attendance-flex-groups.md


NOTENOTE

Principle for calculating a worker's flex balance

Scenario 1: Adjusting a worker's pay and flex account because the allowed flex minimum is exceededScenario 1: Adjusting a worker's pay and flex account because the allowed flex minimum is exceeded

Scenario 2: Adjusting a worker's pay and flex account because the allowed flex maximum is exceededScenario 2: Adjusting a worker's pay and flex account because the allowed flex maximum is exceeded

Flex regulations don't occur during the daily approval and transfer of worker registrations on the ApproveApprove page.

The principle for calculating the hours that the worker's flex balance are adjusted by is set up on the flex group.

Select Time and attendanceTime and attendance > SetupSetup > GroupsGroups  > Flex groupsFlex groups .

The following two principles can be used:

TimeTime – The worker's flexible hours are calculated only from the worker's registered time for the day. When

the worker's daily registrations are calculated, the number of Flex+ and Flex- hours for the day is calculated

from the Flex+ and Flex- zones that are defined in the worker's time profile.

Pay typesPay types  – The worker's flexible hours are calculated based on earnings of the pay types for Flex+ and Flex-

that are defined in the worker's pay agreement. The pay agreement is associated with the time registration

worker. You might want to use pay types to manage flex accounts if, for example, you want to increase a

worker's flex account by a specific factor in one or more flex zones.

A worker who can work flexible hours has a negative flex account.

Flex account:Flex account: -4

The worker is associated with a flex group that has the following configuration:

Flex minimum:Flex minimum: -0.5

Minimum pay type:Minimum pay type: 1302

Pay type factor :Pay type factor : -1.00

As the difference between the worker's flex account and his allowed flex minimum indicates, the worker has

exceeded his allowed flex minimum by 3.5 hours.

When the payroll administrator transfers the worker's pay data by running the Transfer to payTransfer to pay  or FlexFlex

adjustmentadjustment job, the following adjustments are made:

The worker's flex account is adjusted by 3.5 hours. Therefore, the flex balance of -4.0 hours becomes adjusted

to the worker's allowed flex minimum of -0.5 hours.

A pay item for pay type 1302 is created. This pay item has a pay unit of -3.5 hours that will be deducted from

the worker's pay. In this case, the pay unit is a negative number, because the positive adjustment of 3.5 hours

is multiplied by the negative pay type factor of -1.0 that is defined on the flex group. This pay item will be

part of the pay file that is generated by the Transfer to payTransfer to pay  job.

A worker who can work flexible hours has a positive flex account.

Flex account:Flex account: 6

The worker is associated with a flex group that has the following configuration:

Flex maximum:Flex maximum: 2.0

Minimum pay type:Minimum pay type: 1302

Pay type factor :Pay type factor : -1.0

As the difference between the worker's flex account and her allowed flex maximum indicates, the worker has

exceeded her allowed flex maximum by 4.0 hours.



Scenario 3: Managing a worker's flex balance based on pay typesScenario 3: Managing a worker's flex balance based on pay types

P RO F IL E  T Y P EP RO F IL E  T Y P E STA RTSTA RT EN DEN D

Flex+ 12:00 AM 08:00 AM

Clock in 08:00 AM 08:00 AM

Flex- 08:00 AM 09:00 AM

Standard time 09:00 AM 11:30 AM

Paid break 11:30 AM 12:00 PM

Flex- 12:00 PM 04:00 PM

Clock out 04:00 PM 04:00 PM

Flex+ 04:00 PM 12:00 AM
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FlexCnt Flex counter

When the payroll administrator transfers the worker's pay data by running the Transfer to payTransfer to pay  or FlexFlex

adjustmentadjustment job, the following adjustments are made:

The worker's flex account is adjusted by -4.0 hours. Therefore, the flex balance of 6.0 hours becomes adjusted

to the worker's allowed flex maximum of 2.0 hours.

A pay item for pay type 1302 is created. This pay item has a pay unit of 4.0 hours that will be added to the

worker's pay. In this case, the pay unit is a positive number, because the negative adjustment of 4.0 hours is

multiplied by the negative pay type factor of -1.0 that is defined on the flex group. This pay item will be part

of the pay file that is generated by the Transfer to payTransfer to pay  job.

As we explained earlier, flex accounts can be managed based either on the time that is registered in the Flex+

and Flex- zones that are defined the worker's time profile, or on the pay types that are defined in the worker's

pay agreements. If pay types are used, a worker's flex account is adjusted by the pay items that are generated

when you transfer the worker's registration from the ApproveApprove page. You might want to use pay types to

manage flex accounts if, for example, you want to increase a worker's flex account by a specific factor in one or

more flex zones.

This scenario uses the following flex profile that represents a workday.

In this case, you want to be able to manage the worker's flex balance based on pay types. Therefore, you must

set the Based on pay typesBased on pay types  option to YesYes  on the worker's flex group.

To account for the flexible hours, you must also define a new pay type. For this scenario, the pay type is named

FlexCntFlexCnt.

Next, follow these steps to set up a pay type and add lines of the new type to a pay profile.

1. Select Time and attendanceTime and attendance > SetupSetup > GroupsGroups  > Flex groupsFlex groups , and then select NewNew .

2. In both the Flex+Flex+ field and the Flex-Flex- field, specify the new pay type, FlexCntFlexCnt.

3. Select Time and attendanceTime and attendance > SetupSetup > Pay agreementsPay agreements , and then select Agreement linesAgreement lines .
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Clock in 07:00 AM 07:00 AM

Production job 07:00 AM 09:00 PM

Clock out 09:00 PM 09:00 PM
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6.00 0.00 13.50 08.00
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8.00 0.00 13.50 08.00
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PAY  T Y P EPAY  T Y P E
DESC RIP T IODESC RIP T IO
NN F RO M  T IM EF RO M  T IM E TO  T IM ETO  T IM E M IN IM UMM IN IM UM M A XIM UMM A XIM UM FA C TO RFA C TO R

FlexCnt Flex counter 12:00 AM 06:00 PM 00.00 00.00 1.00

FlexCnt Flex counter 06:00 PM 12:00 AM 00.00 02.00 1.50

FlexCnt Flex counter 06:00 PM 12:00 AM 02.00 06.00 2.00

NOTENOTE

4. For MondayMonday , for the Flex+Flex+ profile type, add the following three lines.

Each line is used for a different time interval and has a different factor. The flexible hours that the worker works in

a time interval are multiplied by the factor for that line. For example, hours that are worked from 06:00 PM to

08:00 PM are multiplied by 1.50. The factor is specified in the FactorFactor  field on the GeneralGeneral tab of the PayPay

agreement linesagreement lines page.

The worker enters the following registrations for the day.

The amount that must be paid is calculated on the ApproveApprove page, based on the worker's registration. After the

registration is calculated, you can view the result on the TimesTimes  tab. For this scenario, you're interested in the

following fields.

The amount of Flex+ time is six hours, and the calculation is based on the flex zones in the time profile. This

amount consists of one hour of Flex+ time from 07:00 AM to 08:00 AM and five hours of Flex+ time from 04:00

PM to 09:00 PM.

When you transfer the registrations, you will notice that the amount of Flex+ time is changed from 6.0 hours to

8.0 hours.

This change occurs after the transfer because the flexible hours have been calculated based on pay types instead

of time. The following table shows how the eight hours are calculated.



04:00 PM 06:00 PM 2 1 2

06:00 PM 08:00 PM 2 1.5 3

08:00 PM 09:00 PM 1 2 2

TotalTotal 88
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NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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I receive the following error message: "Warehouse management
processes are currently being used. If work lines are not yet
registered, you can cancel the created work and any load or shipment
lines, and then continue with the picking or shipping process."
Issue descriptionIssue description

Issue resolutionIssue resolution

NOTENOTE

The matching resource name isn't updated after I change a worker
name in the global address book.
Issue descriptionIssue description

Issue resolutionIssue resolution

This topic describes how to fix issues that you might encounter while you work with discrete manufacturing.

This issue occurs if you try to reserve or release work for a line, but the inventory transaction has a status of

Picked, which indicates that the material has been picked.

To fix this issue, follow one of these steps.

Change the status of the production order back to Estimated or Released.

Open the details page for the relevant production order. On the Action Pane, on the WarehouseWarehouse tab, in the

StopStop group, select Stop and unpickStop and unpick to unpick all picked transactions. Then select Remove stopRemove stop to process

the production order.

Here is an explanation of the Unpick and Stop functions:

UnpickUnpick – This function reverses the status of inventory transactions for bill of materials (BOM) lines and

formula lines that have a status from Picked through On order. When work for raw material picking is

completed, the status of the lines is set to Picked. This status prevents the production order from being reset

to Created status. In this case, you can use the Unpick function to revert the transactions from Picked status

and then reset the production order to Created status.

StopStop – This function sets a StoppedStopped flag on the production order to prevent any status update on the order.

You can find the StoppedStopped flag on the WarehouseWarehouse FastTab of the production order details page.

The buttons are visible only when the production order is created for items that are enabled for warehouse processes.

The StopStop group is visible only on the WarehouseWarehouse tab on the Action Pane of the production order details page. It isn't

visible on the WarehouseWarehouse FastTab of the Production ordersProduction orders  list page.

If you change a worker name in the global address book, the matching resource name isn't updated in the

resource group master.

This scenario isn't currently supported. To fix the issue, you must manually update the resource name.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/troubleshoot-discretemanufacturing.md


When I create a new production order, I don't receive the following
message: "Insert the active version of bill of material and route?"
Issue descriptionIssue description

Issue resolutionIssue resolution

Production orders aren't shown on the Marking page.
Issue descriptionIssue description

Issue resolutionIssue resolution

When I try to end a production order, I receive the following error
message: "Calculating BOM consumptionCost value must be negative
upon issue from inventory."

When the status of a production order is changed from Reported as
finished to End, I receive the following error messages: "Update
conflict. The standard cost does not match with the financial
inventory value after the update" and "A critical error has occurred in
function InventCostMovement.checkVariance."

When you create a new production order, after you enter the item number, the S iteSite and WarehouseWarehouse fields are

automatically set to the default site and warehouse that are defined on the Default order settingsDefault order settings  page for

the finished goods item. Additionally, the active BOM number and route number are automatically entered. You

don't receive the following message that prompts you for those values:

Insert active version for bill of material and route?

You aren't prompted to insert BOM and route numbers if you select a product that a site and warehouse are

defined for on the Default order settingsDefault order settings  page. You're prompted only if those values aren't defined for the

selected product.

Some production orders aren't shown on the MarkingMarking page.

Products that have the following configuration aren't available for marking. Therefore, they won't be shown on

the MarkingMarking page:

The products are defined as products of the catch weight type.

They are enabled for the advanced warehouse processes.

They are configured to be controlled by the Standard cost principle.

This issue was fixed in release 10.0.15.

This issue occurs because the underlying data was changed by another process. The process will try to update

the data up to five times. If the conflict still exists after five attempts, you will receive the following error

messages:

Update conflict. The standard cost does not match with the financial inventory value after the update.

A critical error has occurred in function InventCostMovement.checkVariance.

This behavior is by design. To mitigate the issue, resume the batch job. It should finish running.



When I release to a warehouse, I receive the following error message:
"Item RM could not be fully reserved. Ensure that the full quantity is
available, or reserve the items manually if the Reservation field on the
BOM line is set to Manual or Started. Could not release the order to
warehouse because some materials could not be reserved." However,
the status is updated to Released.
Issue descriptionIssue description

Issue resolutionIssue resolution

When I try to end a production order and report as finished, I receive
the following error message: "Total good quantity reported as
finished for the production will be %1. Feedback for the last operation
is 0.00 in total."
Issue descriptionIssue description

Possible causePossible cause

WorkaroundWorkaround

If the batch job consistently fails after you resume it, verify that the rounding precision for the ledger's default

currency is compliant with the rounding that is applied to values in the InventSum table. If the rounding

precision has been changed to a non-compliant value, you probably must change it back to a compliant value.

Look for ModifiedDateTimeModifiedDateTime. In this case, the value will typically show that the rounding precision was recently

changed.

If not all BOM line items are physically available when a production order is released, and the Release toRelease to

warehousewarehouse policy is set to Require full reservation on the production order, you will receive the following error

message:

Item RM could not be fully reserved. Ensure that the full quantity is available, or reserve the items manually

if the Reservation field on the BOM line is set to Manual or Started. Could not release the order to

warehouse because some materials could not be reserved.

This behavior is by design and is working as expected.

When you try to post a report as finished journal on a production order, you receive the following error

message:

Total good quantity reported as finished for the production will be %1. Feedback for the last operation is

0.00 in total.

This issue occurs if the quantities that were posted in the last operations were incorrect. For example, if

production is started, but the quantity that must be started isn't allocated, the route card journal will be posted

without any lines. To confirm the situation, open the production order, and then, on the Action Pane, on the ViewView

tab, select Route cardRoute card.

You can fix this issue by posting additional journals for the operations that the journals weren't correctly posted

for. Restart the production order, and select to post the additional journals. This action won't start the production

order, but it will post the journals. The route card should then show the quantities that were posted, and you

should be able to end the production orders successfully.



Can I report a production order as finished while I report the error
quantity, but not while I report the time or material quantity?

Can I trace the serial numbers of finished goods against the serial
numbers of consumed goods?

NOTENOTE

You can't report the error quantity on a production order unless you also report the good quantity. This scenario

is notnot supported. The report as finished update will eventually fail when you try to end the production order,

and you will receive the following error message:

Missing report as finished quantity.

You can't trace the serial numbers of finished goods against the serial numbers of material that a production

order consumes to make those finished goods. This scenario isn't currently supported. The workaround is to

create production orders for a quantity of 1.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IM P O RTA N TIM P O RTA N T

You can use Supply Chain Management to support the implementation of lean manufacturing with kanbans. However, a
successful implementation of lean principles depends on the internal business processes that you use, and the actual
production conditions and environment.

Modeling manufacturing and logistics processes as production flows

Using kanbans to signal demand requirements

This article provides an overview and description of the lean manufacturing features in Dynamics 365 Supply

Chain Management.

Lean manufacturing offers tools that you can use to model lean operations. These tools support and promote

the following concepts and business activities:

Create a lean manufacturing foundation by modeling manufacturing and logistics processes as production

flows.

Implement a lean pull system by using kanbans to signal demand requirements.

Monitor and maintain kanban jobs.

The lean manufacturing architecture consists of production flows, activities, and kanban rules. These structures

are fully integrated with Supply Chain Management processes. You can use lean manufacturing in a mixed-

mode manufacturing environment that combines various supply, production, and sourcing strategies. These

strategies include production orders, batch orders for process industries, purchase orders, and transfer orders.

To create a lean manufacturing foundation, model the manufacturing and logistics processes as production

flows. This activity consists of the following tasks:

1. Identify the processes for which you want to implement a lean replenishment strategy, and then model these

processes as production flows. You can then analyze and streamline the processes. One of the goals of a lean

implementation is to reduce waste by improving the flow of material and information.

2. Define a production flow as a sequence of activities that describes the flow of material. A transfer activity

defines the movement of a product or products from one location to another. A process activity defines a

value-added operation that is applied to a product.

3. Create a version of the production flow that defines the requirements for takt time. These requirements are

used to calculate the cycle times of each activity in the production flow. You can create multiple versions of

production flows, and then use these versions to improve processes.

A pull system produces goods only when goods are needed. This practice reduces delivery lead times and

excess inventory. You can use kanbans to plan, track, and process requirements that are based on production

flows. To create a kanban framework, create kanban rules that define when kanbans are created, and how the

requirements are fulfilled. You can create two types of kanban rules. Manufacturing rules create process kanban

jobs, and withdrawal kanban rules create transfer kanban jobs. You can set up the following replenishment

strategies:

Fixed quantityFixed quantity  kanban rules are related to a fixed number of handling units, which means that the numbers

of active kanbans are constant. Whenever all the products from a Kanban are consumed and the handling

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/lean-manufacturing-overview.md


Monitoring and maintaining kanban jobs

Kanban jobs and integration with Supply Chain Management
processes

units are manually emptied, a new kanban of the same type is created. When you create fixed quantity

kanban rules, you can calculate the optimal kanban quantities and the product quantities that are used.

The calculation takes into account forecast, actual demand from open orders, lead time to replenish items,

and historical demands.

ScheduledScheduled kanban rules replenish requirements that are calculated by master planning. Master planning

generates planned kanbans that can be firmed to kanbans.

EventEvent kanban rules replenish requirements that originate from sales order lines, production BOM lines,

kanban lines, or minimum inventory settings. When event kanbans are generated, they are pegged to the

source requirements.

When kanbans are created, one or more kanban jobs are generated based on the kanban flow activities that are

defined in the kanban rules.

Lean manufacturing provides visibility into the current status of manufacturing and logistics activities that are

governed by the kanban rules. As a result, you can plan and prioritize the following tasks:

Gain an overview of the current kanban job schedule.

Plan and reschedule kanban jobs.

Track and register the status of kanban jobs.

The following list describes the specialized kanban boards:

Kanban job scheduling – Provides an overview of the kanban jobs. The board displays kanban jobs and their

status for one or multiple work cells. The jobs are listed according to the planning periods (days or weeks)

that are defined in the production flow model. The board also displays the capacity consumption for each

planning period, so that you can monitor the scheduled load. You can change the status of kanban jobs,

reschedule kanban jobs to different planning periods, and perform other tasks.

Kanban board for transfer jobs – This board provides an overview of the current transfer jobs. You can

update and register picking lists, start and complete transfer jobs, and perform other tasks.

Kanban board for process jobs – This board is designed to support the normal production flow and give an

overview of the current situation in one or multiple work cells. From this board Kanbans can be prioritized,

picked, or manufactured. The board is also designed to support barcode scanning for the reporting of

Kanbans.

Kanban jobs are fully integrated with current processes for inventory transactions in Supply Chain Management.

You can perform picking activities to replenish material that is used to fulfill the requirements of kanban jobs.

You can print kanban cards, circulating kanban cards, and picking lists to support the use of kanbans. These

documents are used to represent, track, and register kanban jobs in the warehouse and on the production

floor.

You can register the picking and transfer activities in inventory by scanning bar codes.

In addition, lean manufacturing supports the purchasing and invoicing processes for services that are

referenced by subcontracted activities.

You can assign purchase agreement lines and services to subcontracted activities.

You can create periodic purchase orders and receipt advices to support the purchase and invoicing of the

services.
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Production flows that involve subcontractors

Purchase process for subcontracted activities (services)

This topic describes, in detail, how to use subcontracted activities in a production flow for lean manufacturing.

In Microsoft Dynamics 365 Supply Chain Management, there are two approaches for subcontracting: production

orders and lean manufacturing. In the lean manufacturing approach, the subcontracting work is modeled as a

service that is related to an activity of a production flow. A special type of cost group type that is named DirectDirect

outsourcingoutsourcing has been introduced, and the subcontracting services are no longer part of a bill of materials

(BOM). The cost accounting of subcontracted work is fully integrated into the costing solution for lean

manufacturing.

The basic principle of a production flow doesn't change when activities are subcontracted. Material still flows

between locations, process activities convert material to products, and transfer activities move material or

products from one location to another. You can model locations and work cells as vendor-managed by assigning

the vendor account to a warehouse or to a resource of a resource group.

Based on these capabilities, lean manufacturing doesn't require any specific features in order to support the flow

of material and products. All possible scenarios that involve vendors as providers of production or transport

services can be modeled based on the architecture of production flow and activities.

For example, a subcontractor works out of a supermarket that is located at the subcontractor. When handling

units are emptied at the subcontractor, the kanban cards are returned to the assembly cell together with the next

shipment. The supermarket at the subcontractor is then replenished. The transfers to and from the

subcontractor can be modeled as explicit transfer activities to support a picking and shipment process. If an

explicit registration isn't required in order to support the physical transport, the transfer activities can be

omitted.

A subcontractor can be used to load balance the overall capacity of the production flow. For example, a

production flow is modeled by using scheduled kanban rules. The planner uses the kanban scheduling board to

schedule and load level both work cells on demand. The planner also monitors the consolidated supply schedule

for the supermarket on the Supply scheduleSupply schedule page. Multiple subcontractors can be modeled in one or multiple

production flows, and there might be multiple kanban rules that can be used to supply the same product to the

same location through different activities. The planner can convert kanbans to an alternative kanban rule to

reschedule a kanban that was originally created for internal production to an alternative process. In fact, the

subcontracted nature of the work cell has no impact on the production flow. The same working principle applies

for two parallel internal work cells or for two subcontracted cells.

Like any other activity in a production flow, subcontracted activities can consume and supply inventoried, non-

inventoried (work in process [WIP]), and semi-finished material and products. In all cases, the processes for

scheduling and executing subcontracted activities are the same. Additionally, these process the same as the

processes for internal work.

The purchase process for subcontracted activities is based on the physical material flow that is registered by

kanban job progress, for example, Start or Complete. The financial flow, for example, cost of subcontracted work,

is a secondary flow that follows the physical flow. At the same time, the purchase process is an independent

process that allows for manual adjustment of the purchase documents at every step. Here is the purchase
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process for subcontracted activities:

1. Create a purchase agreement. The purchase agreement is created for the service and connected to the

activity of the production flow.

2. Create a purchase order. A release purchase order can be created for the service, based on the scheduled

kanban jobs. Jobs for the same service can be grouped to purchase order lines by day, week, or month. The

purchase order lines can be created at any time after the kanban jobs are created. Purchase order lines can

even be created after the fact. This option is usually selected if a subcontractor provides services without

additional notice, based on the kanbans or kanban cards that the subcontractor receives. In this case,

deviations between the purchase order and the invoice can be minimized.

3. Generate kanban cards, material, and a picking list to send to the subcontractor to prepare for processing.

Based on the detailed modeling of the production flow, the preparation is done on the kanban board for

process activities by using the picking list and the preparation function. Alternatively, the preparation is done

on the kanban board for transfer jobs by using the picking list and start or completion. For inventoried

material, both processes can be supported by a WMS-Picking and Shipment process. A bill of lading can be

created on demand.

4. Generate kanban handling units and kanban cards. After processing, cards are returned from the

subcontractor. Usually, the cards include a delivery note that specifies the physical material that has been

shipped. A reference to the provided services isn't required. The arrival of the material or product at the

customer is registered on the kanban board, depending on the kanban cards. (Either the kanban board for

process activities or the kanban board for transfer jobs is used, depending on the modeled activities.).

5. Create a receipt advisory. The receipt advisory can be used to replace a packing slip document for the

received services. Receipt advisories can be generated based on the completed kanban jobs for the

subcontracting activity for a selected period. For each job receipt, advisories are created for the related

purchase order line. The receipt advisory can be printed and sent to the subcontractor as confirmation of

receipt.

6. Generate an invoice.

The process ends when the subcontractor is invoiced for a period. The invoice match is done against the receipt

advisories that are created. Because the receipt advisories represent the exact physical receipt of material, the

three-way matching is simplified.

The following sections describe how to configure activities for subcontracting.

The payment item that is used in activity-based subcontracting must be a product that has the following

properties:

Product type:Product type: Service

Inventor y model group:Inventor y model group: Non stocked

This requirement enforces the use of the first in, first out (FIFO) inventory model. Note:Note: Cost calculation of the

products requires that the standard cost of the service be defined. A purchase agreement with the vendor is

required. Otherwise, the service can't be used for activity-based subcontracting.

To configure a process activity as a subcontracted activity, follow these steps.

1. Configure a subcontracted work cell. To configure a work cell as subcontracted, you must create a resource of

the VendorVendor  type and associate it with the work cell (resource group). A runtime cost category of the DirectDirect

outsourcingoutsourcing cost group type should be assigned to the work cell. The cost categories for setup and quantity

aren't required.
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Service quantity calculation

Cost accounting of subcontracted services

2. After a process activity is created and related to a subcontracted work cell, you must configure a service for

the activity before the production flow version can be activated. You complete this step on the ActivityActivity

detailsdetails  page. For activities that are associated with a subcontracted work cell, the Ser vice termsSer vice terms FastTab is

shown. On this FastTab, add a default service that is valid for all output items. If specific output items require

different services or different service calculation parameters (for example, a different service ratio), you can

add other services to the activity.

A transfer activity is configured as a subcontracted activity, depending on the Freighted byFreighted by  setting of the

transfer activity. The following options are available:

ShipperShipper  – The activity is subcontracted if the transfer from the warehouse is managed by a vendor (as

defined by a property of the warehouse). All selected purchase agreements for services must have the same

vendor ID as the warehouse.

RecipientRecipient – The activity is subcontracted if the transfer to the warehouse is managed by a vendor (as

defined by a property of the warehouse). All selected purchase agreements for services must have the same

vendor ID as the warehouse.

Carr ierCarr ier  – The activity is subcontracted to any vendor that provides the service. To be valid, a carrier must be

created for warehouse management and must have an assigned vendor account.

As for process activities, you must configure a default service for subcontracted transfer activities on the

Ser vice termsSer vice terms FastTab of the ActivityActivity  detailsdetails  page.

The whole purchase process is based on an item reference for a service. This item reference is measured in a

unit of measure of a service. Services are usually measured either in the number of services (units) or in time. To

calculate the service quantity, based on the registered completion of kanban jobs, you can use the following

methods:

Calculation that is based on the number of jobsCalculation that is based on the number of jobs  – One kanban job equals n units of service, regardless

of the product quantity that is supplied. In lean manufacturing, one job corresponds to one handling unit.

This calculation method applies to all services that have a fixed price per handling unit. Therefore, this

method usually applies to transfer activities. However, it can also apply to process activities that process

whole handling units.

Calculation that is based on the product quantityCalculation that is based on the product quantity  – The service quantity is relative to the product

quantity that is scheduled/supplied. When the supplied product quantity is calculated, error quantities can be

either included or excluded. This calculation method applies to all cases where the service price per unit of

processed product is agreed upon.

Calculation that is based on the activity timeCalculation that is based on the activity time – The theoretical activity times are calculated, based on

the processing time of the activity, the total processed quantity, and the throughput ratio of the processed

product. This calculation method applies to services that are paid by the hour and have a variance in time per

processed product.

When the receipt advisory or a vendor packing slip on a purchase order that was created for a production flow

(in other words, a purchase order that was generated based on kanban jobs for subcontracted activities) is

posted, the value of the receipt is accounted in the WIP accounts of the production flow. Deviations of invoices

are also accounted to the production flow. A cost category for subcontracted work has been introduced. This

cost category enable transparent tracking of the value of subcontracted work that is allocated to WIP and

consumed per period.
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The backflush costing for lean manufacturing at the end of a costing period calculates the actual variances of the

products that are produced from the production flow during the costing period.

People often consider transport nonproductive and think that it adds no value. However, when the cost of

subcontracting is compared to the cost of internal production, the cost of additional transport activities must be

considered. A production flow that spans multiple locations and requires transport services should model the

transport cost as part of the cost of supplying the products to the customer.

Activity-based subcontracting in lean manufacturing lets you integrate carriers and transport vendors that move

material and products between the locations of a production flow. By modeling a transfer activity, you can assign

a carrier or vendor. The transfer activities/job is based on a service and purchase agreement, and you can create

purchase orders and receipt advisories, based on the actual transfer jobs. This functionality is the same as the

functionality for subcontracted process activities.

Supply Chain Management now supports BOM calculation that includes transport services, the creation of

related purchase orders, integrated receipt registration, and the integration of transport service costs into the

production flow costing.
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Production flows in lean manufacturing

Semi-finished products (non-BOM levels)

Products and material in work in progress

Value streams and value stream mapping

The article provides information about the key concepts in modeling a lean organization.

Typically, a lean manufacturing scenario is more than just a collection of unrelated kanban rules or material

supply policies. The flow of material and products throughout work cells and locations for a specific production

or supply scenario can be described as a sequence or small network of process or transfer activities. This

sequence or network is known as a production flow.

In production scenarios that are based on production orders, material is issued to a specific production order.

During a sequence of operations that is based on a bill of materials (BOM) and routes, products are created and

are finally received at the supplied location. The throughput time of production orders varies from minutes to

weeks. All related cost, material, and labor are accumulated on the production order.

To reduce the delivery lead times and excess inventory between work centers that batch production causes, lean

manufacturing introduces kanban replenishment and supermarkets in manufacturing and warehouse

replenishment. Typically, these features disrupt the production of partially independent kanban cycles. The

replenishment of a kanban for a semi-finished product is no longer triggered by an order for a finished product.

To re-establish a production and cost context for the various kanban scenarios that are proposed, activity-based

production flows have been introduced as the backbone of lean manufacturing. All kanban rules refer to this

predefined structure. The activity-based model supports the setup of a wide range of scenarios. However, this

model doesn't add complexity for the shop floor workers, because all scenarios use the same activity-based user

interface.

Lean manufacturing integrates kanbans for inventoried products and semi-finished products in a single

framework, and therefore offers a unified user experience for all cases. Because of this architecture, additional

BOM levels no longer have to be introduced to enable kanbans to be used for semi-finished products. This

architecture also helps reduce inventory transactions to a minimum.

The reduction of batch sizes to the ideal state of a single piece flow in lean manufacturing can cause a dramatic

increase in inventory transactions if each picking process or kanban registration causes transactions for the

consumed items. The production flow architecture allows for the transfer of material to the production flow,

together with the withdrawal kanbans in storage or transport handling unit sizes. The value of the issued

material is added to the work in progress (WIP) account that is related to the production flow. This behavior

resembles the behavior for material that is issued to a production order. The same principle can be applied to

products and semi-finished products. Unless these products are created, transferred, or consumed within a

production flow, inventory transactions are optional. After the products are posted to inventory, the WIP account

for the production flow is reduced by deducting by the related standard cost.

The architecture of Lean manufacturing is inspired by the five Lean principles that were formulated by Womack

and Jones: Customer value, Value stream, flow, pull, and perfection. One approved method for implementing
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Continuous improvement

Simplicity

NOTENOTE

lean manufacturing solutions in the physical world of manufacturing is value stream mapping (VSM). This

method was introduced by Rother and Shook in their publication “Learning to See” at the Lean Manufacturing

Institute.

The future-state value stream can be modeled as a production flow version. All processes of the value stream

are modeled as process activities. Movements or transfers can be modeled as transfer activities if the transfer

status must be registered, or if integration with inventory picking or consolidated shipments is required.

The value stream itself is modeled as an operating unit. Therefore, the value stream can be used as a financial

dimension.

For more information about operating units, see Create an operating unit.

The periodic consolidation of the cost for a production flow corrects the related WIP account and enables

variances to be determined for the products that are supplied by the production flow.

To better support continuous improvement, the production flows are implemented in time-effective versions.

Therefore, an existing production flow version, together with all related kanban rules, can be copied to a future

version of the production flow. In addition, the future-state production flow can be modeled before it's validated

and activated for production. To help guarantee a seamless material flow on the transition date and beyond,

existing kanbans from old production flow versions are automatically related to the new version.

For the implementation of Lean manufacturing, we choose a production flow and activity approach that enables

simple and complex production scenarios to be modeled in a single scalable architecture. A closer look at the

activity concept reveals a new simplicity for those users who require it: the shop floor and logistics workers. By

reporting against activity-based jobs instead of inventory transactions, a unified user interface for all lean

manufacturing variants transfers the business complexity from the user interface to where it belongs: the

production flow as the backbone of lean manufacturing.
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Operations resources

Calendars

Resource capabilities

Operations resources perform the activities of a project or a production process. They can be of different types,

and can have different capabilities.

Operations resources are the machines, tools, workers, facilities, physical areas or vendors that perform the

activities of a project or a production process. They can be of different types and can have different capabilities.

VendorVendor  – An external resource that performs project activities or production operations. An example is a

subcontractor. By linking vendor resources to a vendor account, you can generate purchases for

subcontractors, based on the bill of materials (BOM) lines or production lines.

Human resourcesHuman resources  – A project or production worker that perform an activity, either alone or as an operator

of a tool or a machine. If you're using the Human resources functionality, you can link human resources to a

worker. The scheduling engine can then allocate the resources, based on the competencies that are defined

for the corresponding worker.

MachineMachine – A machine or other production equipment that is required in production.

ToolTool  – An instrument or device that is typically used together with another resource to perform an activity in

a project or in production.

LocationLocation – A physical location of a specific size that is required in order to perform an activity. An example is

an assembly area.

FacilityFacility  – A building or fixed structure that is required in order to perform an activity.

A calendar can be assigned to an operations resource and describes the capacity (in hours) of that resource. The

working times of the operations resource are determined by the calendar that is assigned to the resource group

that the operations resource is part of. You can set an effective date and an expiration date for the assigned

calendar. You can then assign more than one calendar to an operations resource. However, the dates of the

assigned calendars can't overlap, and the operations resource can be assigned only one calendar at a time.

Note:Note: If there are no effective working calendars for a resource group (for example, if the last assigned calendar

or the only assigned calendar has expired), you can no longer access the operations resources that are assigned

to the resource group for production planning and operations scheduling. You can also assign a calendar to a

resource group to specify the working times for both the resource group and all the operations resources that

are assigned to the resource group. The capacity of the resource group is calculated as the sum of the capacities

of each operations resource that is assigned to that resource group. The calendar that is assigned to a resource

group can change over time.

A capability is the ability of an operations resource to perform a particular activity. You can assign one or more

capabilities to an operations resource. The scheduling engine will then allocate resources by matching the

resource requirements of each activity to the capabilities of the available operations resources. Capabilities can

be assigned to all types of operations resources (ToolTool , VendorVendor , MachineMachine, Human resourcesHuman resources , LocationLocation, or

FacilityFacility ). To assign capabilities to operations resources for a limited time, define a start date and an expiration

date on the capability assignment. For more information, see Resource capabilities.
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A resource group is a set of operations resources that represents the granularity at which you want to schedule

resources when you use the operations scheduling method. Therefore, resource groups typically correspond to

the physical organization of work cells that is demarcated by yellow lines on the production shop floor. The

resource group defines the site, production unit, and warehouse context for operations resources that are

assigned to the group. When you assign an operations resource to a resource group, the resource can be

scheduled at the site where the resource group is located. You don't have to assign the operations resources that

you create to a resource group. However, an operations resource must be assigned to a resource group before it

can be scheduled to perform work. An operations resource can be assigned to a resource group for a limited

time. You can also assign an operations resource to multiple resource groups, so that you can then share the

resource across sites. However, the effective dates and expiration dates can't overlap. In other words, you can't

assign an operations resource to two resource groups at the same time. Changes in resource group

assignments are effective only for new resource allocations. Capacity reservations for jobs, operations, and

project hour forecasts that are already scheduled won't be affected. Note:Note: When you assign operations

resources of the VendorVendor  type to a resource group, all operations resources that are assigned to that resource

group must be of the VendorVendor  type and must be linked to the same vendor account.

A production unit is an administrative unit that is a collection of resource groups. A production unit can contain

multiple resource groups, but a resource group can be assigned to only one production unit. A production unit

reflects the physical layout of production resources, and has no effect on transactions or how they are

processed. You must associate a production unit with a site. You can also assign a picking warehouse and a

storage warehouse to a production unit. You can use a production unit to consolidate and filter production-

related data. For example, a shop floor manager can see an overview of the outstanding workload and the

available capacity for a particular production unit. You can change the production unit that is assigned to a

resource group. You can also delete a production unit. However, these changes to the production unit are

effective only for new orders that are created after master scheduling is run. If you want to apply the production

unit change to existing orders, you must make this change manually.

Operations resources are assigned to activities when a project or a production is scheduled. Two scheduling

methods are available: operations scheduling and job scheduling. When you use operations scheduling, each

operation or project activity is scheduled on the resource group that contains operations resources that match

the resource requirements that are specified for the operation. If a specific operations resource is required for

the operation, scheduling reserves capacity only on a specific operations resource in the group. Job scheduling

is a more detailed form of scheduling than operations scheduling. It breaks down each operation into its

individual tasks or jobs. These jobs are then assigned to the operations resources that will perform them.

Scheduling reserves capacity on the resource groups, based on the operation times that are defined on the

production route or project activities. If you're working with finite capacity, the schedule depends on the

availability of the operations resources that are required in order to complete the activity. For operations

scheduling, the capacity of the resource group is the sum of the available capacity of the operations resources

that are part of that group. Capacity reservations that already exist for the operations resources are considered

unavailable capacity. If there isn't enough available capacity for production, the production orders can be

delayed or even stopped. On the ResourcesResources  page, you can define several properties that control how capacity

reservations are made:

CapacityCapacity  – Specify the operations resource's capacity per hour in terms of the capacity unit of measure.

Batch capacityBatch capacity  – Specify the maximum number of pieces that the operations resource can process per run.

Efficiency percentageEfficiency percentage – Specify the efficiency that you expect from the operations resource. The efficiency

percentage adjusts the throughput of the operations resource and affects the time that is reserved for the
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resource. The lead times for the operations that use the operations resource are also adjusted accordingly.

Here is the formula that is used for the calculation: Scheduling time = Time × 100 ÷ Efficiency percentage.

Time includes both the run time and setup time.

Operations scheduling percentageOperations scheduling percentage – Specify the maximum percentage of capacity of the operations

resource that you want to use in operations scheduling. To allow for flexibility in capacity during job

scheduling, you should set this percentage to less than 100 percent.

Finite capacityFinite capacity  – Set this option to YesYes  if the operations resource should be scheduled based on the actual

capacity that is available, and if existing capacity reservations should be considered. If this option is set to NoNo,

the operations resource is assumed to have infinite capacity, and the resource might therefore be

overbooked.

Finite proper tyFinite proper ty  – Set this option to YesYes  if you want the operations resource to be scheduled based on the

actual capacity that is available with respect to the required working time scheduling properties.

ExclusiveExclusive – Set this option to YesYes  if you don't want the operations resource to be available for another job or

operation until the current production is completed. In this case, the operations resource can't be used even if

there are gaps in the resource's run time.

Bottleneck resourceBottleneck resource – Define the operations resource as a bottleneck resource. A bottleneck resource is

scheduled by using finite capacity when the Finite capacityFinite capacity  and Bottleneck schedulingBottleneck scheduling options on the

Master plansMaster plans  page are selected.

To schedule multiple operations resources at the same time to perform, for example, an operation in production,

you must specify the requirements for the various resources by using primary and secondary operations. You

can then also reserve multiple operations resources that have different capacity. The operations resource that

are scheduled for the primary operation determine the duration of the activity.

You can specify that a resource group is a lean work cell. The resource group can then be part of a production

flow. By specifying a resource group as a lean work cell, you also prevent the resource group and the assigned

operations resources from being allocated to the operations of a production order or a project hour forecast. For

each resource group that acts as a lean work cell, you must specify the following information:

CalendarCalendar  – The working calendar of the work cell, which must have the property of a standard workday.

Input warehouse and locationInput warehouse and location – The default location that is used to pick material for an activity.

Output warehouse and locationOutput warehouse and location – The default location where all output of the work cell is put.

Runtime cost categor yRuntime cost categor y  – This category must be defined for the work cell if direct labor is tracked in

costing.

When a resource group is used as a lean work cell, the capacity of the work cell is specified directly on the

resource group. Therefore, you don't have to assign operations resources to the resource group. Only when the

work cell is managed by a subcontractor, an operations resource of the VendorVendor  type must be assigned to the

work cell. If you assign an operations resource to a resource group that is marked as a work cell, the capacity of

the work cell isn't affected.

When you define an activity such as a route operation or a project hour forecast, you can specify the

requirement for a specific operations resource or resource group. However, you can also specify the

requirement for an operations resource of a specific type, or an operations resource that has a specific capability

or competency. For this reason, the actual resource assignment isn't made until the activity is scheduled and

capacity is reserved. Therefore, on a route operation, you can specify that estimation and BOM calculation must

be based on a specific operations resource. This operations resource is referred to as the costing resource. You

can also transfer cost categories and operation times from the costing resource to the activity. When the

operation is scheduled, estimation and BOM calculation are done by using the operations resource that is
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actually scheduled.
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Create a work cell.

A work cell is a specific form of resource groups that can be used in lean manufacturing process activities. Work

cells have input and output locations and a capacity definition based on a production flow model. To learn more

about the basic concepts of lean manufacturing work cells and capacity calculations, see the white papers on

Lean manufacturing. The demo data company used to create this procedure is USMF

1. Go to Organization administration > Resources > Resource groups.

2. Click New.

3. In the Resource group field, type a value.

4. In the Description field, type a value.

5. In the Site field, click the drop-down button to open the lookup.

6. In the list, click the link in the selected row.

7. In the Production unit field, click the drop-down button to open the lookup.

8. In the list, click the link in the selected row.

9. Select the Work cell check box.

10. In the Input warehouse field, click the drop-down button to open the lookup.

11. In the list, click the link in the selected row.

12. In the Input location field, click the drop-down button to open the lookup.

13. In the list, click the link in the selected row.

14. In the Output warehouse field, click the drop-down button to open the lookup.

15. In the list, find and select the desired record.

16. In the list, click the link in the selected row.

17. In the Output location field, click the drop-down button to open the lookup.

The work cell ID is typically a systematic code and has to be unique for the legal entity.

The description contains the name or title of the work cell.

A work cell is located at one specific site. Both input and output warehouse and location have to be

located on this site.

Select a production unit that this work cell belongs to.

To use a resource group as a lean work cell, the Work cell check box has to be selected. Note that this

property cannot be changed after resource group is created.

For accounting and material control, the material staged on the shop floor is typically allocated to a

specific virtual warehouse. However, if you want to replenish the locations using warehouse work,

they must be part of the receptive raw material warehouse.

Note that for a process activity, the input location can by overwritten in general or for a specific

product or product variant by defining picking activities that feed to the process activity. The input

locations of a work cell cannot be license plate controlled.

In multiple activity production flows or production lines, this is often the input warehouse of the next

work cell or the sales or transit warehouse where a product is typically transferred to after the

production process. Remember when modeling lean manufacturing processes, transport is usually

waste, as is reporting transport.

In a production flow with multiple process activites this if often the input location of the next work cell.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/define-lean-manufacturing-work-cells.md


Add a financial dimension

18. In the list, find and select the desired record.

19. In the list, click the link in the selected row.

20. Expand or collapse the Operation section.

21. In the Run time category field, click the drop-down button to open the lookup.

22. In the list, find and select the desired record.

23. In the list, click the link in the selected row.

24. Expand or collapse the Calendars section.

25. Click Add.

26. In the Calendar field, click the drop-down button to open the lookup.

27. In the list, find and select the desired record.

28. In the list, click the link in the selected row.

29. Expand or collapse the Work cell capacity section.

30. Click Add.

31. In the Production flow model field, click the drop-down button to open the lookup.

32. In the list, find and select the desired record.

33. In the list, click the link in the selected row.

34. In the Capacity period field, select an option.

35. In the Average throughput quantity field, enter a number.

36. In the Unit field, click the drop-down button to open the lookup.

37. In the list, click the link in the selected row.

38. ResolveChanges the Unit.

A Run time category must be provided to enable cost calculation and processing of lean kanban jobs.

The run time cost category is used in standard cost calculation and on backflush costing.

Typically work cells of a given site use the same working time calendar. If work cells can have

individual working times, you might need to create a specific working time calendar for the work cell.

Note that the calendar should have a standard working time defined when used for a lean work cell,

because the capacity definition is usually related to the standard working time of a work day.

This procedures requires production flow model type Throughput, to show the definition of

throughput capacity.

The options include: Standard workday - The capacity is expressed by the length of the standard

workday of the working time calendar for the work cell. For each day, the actual working time is

determined from the calendar and the effective available capacity is calculated based on that. Week -

Allows a weekly capacity. There is no adjustment done by the actual working time. Month - Allows a

monthly capacity. There is no adjustment done by the actual capacity. Typically, the standard workday

is used for daily periods and the weekly capacity is used for weekly capacity periods.

Note that a lean operation is never set up for the maximum possible capacity in an ideal environment.

Instead the capacity should always be defined for operations running under typical circumstances.

1. Expand or collapse the Financial dimensions section.

2. In the CostCenter field, click the drop-down button to open the lookup.

3. In the list, find and select the desired record.

Note that financial dimensions defined on the production flow override the financial dimension of a

given work cell. The financial dimensions that can be selected depend on the configuration of the

financial dimensions of your system. The following steps correspond to the Demo data set in company

USMF. When using different data, the steps might not be applicable.

The dimensions that need to be selected on lean work cells depend on the implementation of financial

dimensions in the accounting model for a specific legal entity.
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4. In the list, click the link in the selected row.

5. In the ItemGroup field, click the drop-down button to open the lookup.

6. In the list, find and select the desired record.

7. In the list, click the link in the selected row.

1. Click Save.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Define lean schedule groups
2/18/2021 • 2 minutes to read • Edit Online

Define lean scheduling group

Associate product

Associate item allocation key

Lean schedule groups are defined to group and distinguish products in kanban scheduling. The grouping can be

done as generic association per company or specific to a work cell. Each group has a color code assigned for

visual indication in the kanban scheduling listpage. The demo data company used to create this procedure is

USMF.

1. Go to Product information management > Lean manufacturing > Lean schedule groups.

2. Click New.

3. In the Schedule group field, type a value.

4. Select a color from the color selection.

5. In the list, mark the selected row.

6. In the list, click the link in the selected row.

A schedule group can be defined as global group or specific to a work cell. In this simple example, we

define a global group, and the work cell is kept empty. The settings of this group apply to all work cells

that do not have specific schedule groups.

The colors are used to highlight the jobs on the kanban schedule list page or the kanban process

board.

1. Associate a specific product

2. In the Item relation type field, select Item

3. In the Item number field, type a value.

4. In the Throughput ratio field, enter a number.

There are two ways to associate products to lean schedule groups, either as a specific product (Item

relation type = Item) or as part of an item allocation key (item relation type = group).

The default Throughput ratio is 1, which means that the related products consume exactly the capacity

specified in the process activites of the production flows. Throughput ratio > 1 defines a higher

resource consumption, Throughput ratio < 1 defines a lower resource consumption. The ratio is used

in the cost calculation and in the calculation of the kanban job consumption.

1. Associate an item allocation key

2. In the Item relation type field, select Group

3. In the Item allocation key field, click the drop-down button to open the lookup.

4. In the list, click the link in the selected row.

Add an association to an item allocation key by using the Item relation type Group. Note that for this

process, you need a forecast item alllocation key defined in your data.
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Visual scheduling of kanban jobs

Kanban schedule board

This topic provides information about the Kanban schedule board, which the production planner can use to

control and optimize the production plan for kanban jobs.

This topic provides information about the Kanban schedule board, which the production planner can use to

control and optimize the production plan for kanban jobs.

The Kanban schedule board lets the production planner control and optimize the production plan for kanban

jobs. It makes the flow of kanban jobs transparent, and gives the production planner a tool that optimizes and

adjusts the production plan for the lean manufacturing work cell.

A kanban job can consist of one or many kanban jobs. There are two types of kanban jobs:

Process

Transfer

You can schedule only jobs of the ProcessProcess  type. The kanban job and its properties, such as the activity time, are

defined in the production kanban flow. In the production kanban flow, the kanban job is also assigned to a work

cell. The work cell's daily capacity is calculated based on the work cell capacity that is set on the resource group.

It's adjusted by the daily working time in the related calendar. When a kanban job is scheduled, the job loads the

capacity of the work cell. The Kanban schedule board provides the following main features:

A graphical overview of the production plan in a lean work cell. This overview shows the planned kanban

process jobs in the defined periods.

A tool that lets you schedule unplanned kanban jobs and reschedule previously scheduled jobs.

The Kanban schedule boardKanban schedule board page contains seven main elements, as shown in the following illustration.
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The board is divided into periods, each of which is represented as a node (4). The period nodes are listed on the

vertical axis, and the horizontal axis represents a time scale (7) that shows the length of the period. A period has

a length of either one day or one week. The period length is determined by the configuration of the work cell

that is selected for the Kanban schedule board (2). For each period node, the Kanban schedule board indicates

how much the scheduled kanban jobs are loading the period. There is also an indication of the maximum

throughput for the period. If the scheduled throughput exceeds the maximum throughput, the period is

considered as overloaded, and a red warning symbol appears. A scheduled kanban job appears in a period that

has scheduled start and end times (5). The length of the job is equal to the activity time. Kanban jobs appear as

overlapping in a period if their activity times exceed the task time of the work cell.

More information about a kanban job is available in the tooltip that appears when you hover the pointer over

the job. A symbol provides information about the status of the job. For example, a clock symbol indicates that

the kanban job is overdue.

To enhance the overview that the Kanban schedule board provides, you can use colors to distinguish kanban

jobs. The color of a kanban job is configured in the lean schedule group, where you can aggregate the products

that should be produced in the same sequence. The Use theme colorsUse theme colors  button on the BoardBoard tab of the Action

Pane lets you switch between the application theme colors and the colors that are configured in the lean

schedule group. For each period, a capacity bar (6) indicates how many of the available hours for the period

have been loaded with kanban jobs. If the period is overloaded, the capacity bar appears thicker and in red. All

these functions are available on the BoardBoard tab of the Action Pane (1) at the top of the Kanban schedule boardKanban schedule board

page.

You can schedule unplanned kanban jobs from the Plan unplanned jobsPlan unplanned jobs  dialog box. To open this dialog box,

click the Unplanned jobsUnplanned jobs  button that shows the current number of unplanned jobs. Alternatively, click PlanPlan

unplanned jobsunplanned jobs  on the BoardBoard tab of the Action Pane. The dialog box shows a list of the unplanned kanban

jobs for the work cell. You can use the FilterFilter  field to filter on all fields in the grid. For example, you can filter on

kanban jobs for a specific product. After you have a filtered list of the jobs that you want to schedule, select them

in the list, and then click OKOK. To use automatic planning to schedule the jobs, set the Automatic planningAutomatic planning

option to YesYes . In this case, the jobs are scheduled into a period according to their due date. You can also

schedule the jobs by period. Just select a period in the PeriodPeriod field. The following illustration shows an example

of the Plan unplanned jobsPlan unplanned jobs  dialog box.
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You can change the sequence of one or more selected jobs within a period. This capability can be useful if you

want to prioritize some jobs within the period. Alternatively, you might want to sequence jobs that have the

same product attributes, to optimize job execution. You can change the sequence through a drag-and-drop

operation, or by using the BackwardBackward and For wardFor ward menu items on the BoardBoard tab of the Action Pane.

Jobs can be reassigned from one period to another. This capability can be useful if a period is overloaded and

you want to level the load to periods that have spare capacity. You can reassign jobs through a drag-and-drop

operation, or by using the Next per iodNext per iod and Previous periodPrevious period menu items on the BoardBoard tab of the Action Pane.

You can open the Kanban schedule board by using the menu item on the following pages:

Production areaProduction area page

Kanban jobs schedulingKanban jobs scheduling page

Production flow visualizationProduction flow visualization page

Kanban job scheduling for lean manufacturing
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Automatic scheduling of kanban jobs

Manual scheduling

Lean scheduling groups

This article provides information about visual control over kanban job scheduling and various ways to schedule

kanban jobs.

The Kanban job schedulingKanban job scheduling page provides visual control over the schedules of lean manufacturing work cells.

It gives an overview of all kanban jobs and provides multiple filtering capabilities. From this page, you can move

to all other pages that are related to kanban configuration and execution.

Scheduling can be triggered automatically if you set the Automatic planning quantityAutomatic planning quantity  parameter on the

kanban rule. If you set Automatic planning quantityAutomatic planning quantity  to 11 , each kanban job is planned immediately when it's

created. The result is a series of first pull, first serve operations. If you set Automatic planning quantityAutomatic planning quantity  to a

value that is more than 1, kanban jobs are grouped before they are planned.

This concept enables kanban sizes to be reduced below the actual economic batch sizes. For example, the

economic batch size for a specific item (or item family) is 30. Instead of creating kanbans that use the product

quantity, 30, you can configure the kanban rule so that it has a product quantity of 10 and an AutomaticAutomatic

planning quantityplanning quantity  value of 33 . Although automatic planning schedules the kanban jobs for the work cell only

when three unplanned jobs exist, it's fully transparent to the planner and the shop floor supervisor that two

unplanned jobs might be awaiting execution. The planner or shop floor manager can then take those two jobs

into production by manually planning them or creating additional kanbans.

For manual scheduling, Microsoft Dynamics AX 2012 introduced the kanban scheduling board. Manual

scheduling can be combined with automatic scheduling. The kanban scheduling board lets you plan and unplan

jobs, moved them in sequence, or move them from period to period. Jobs that are based on a kanban rule

where the Automatic planningAutomatic planning value is more than 00  can be manually unplanned. However, these jobs will be

replanned when the next automatic planning event occurs (that is, when a new kanban is created). The following

options are available for manual scheduling:

ScheduleSchedule schedules the selected jobs according to their due date. (This option resembles automatic

planning.)

Schedule for ward from dateSchedule for ward from date tries to schedule the selected jobs according to their due date but constrains

the result by using the specified earliest start date.

BackwardBackward moves the selected scheduled jobs back in the sequence within the period.

For wardFor ward moves the selected scheduled jobs forward in the sequence with the period.

Previous periodPrevious period moves the selected scheduled jobs to the start or end of the previous period.

Next per iodNext per iod moves the selected scheduled jobs to the start or end of the next period.

PlanPlan > Rever t job statusRever t job status  lets you unschedule a scheduled job.

Each color represents a lean scheduling group. Lean scheduling groups can be freely defined as generic groups

or as groups that belong to a single work cell. Items and dimensions can be freely assigned to the scheduling

groups. For example, in a Painting cell, a schedule group can represent a color of the product. In work that is

driven by specific tooling requirements, items might be grouped by tool requirement, and a packaging work cell

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/lean-manufacturing-kanban-job-scheduling.md
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might group items by packaging template. The use of colors for lean scheduling groups is optional but

recommended. It improves visibility into the status of the plan. For example, it's very easy to see which colors

are produced on which day, and you can tell at a glance how this work can be optimized.

The capacity of a lean work cell is always concurrent capacity. In other words, multiple jobs can be active in a

work cell at the same time. The capacity can be tracked in two modes: throughput and hours.

The capacity of a work cell is defined by the average throughput quantity of a reference period (standard

workday, week, or month). The actual capacity per day or week is then calculated based on the working times of

the calendar that is assigned to the work cell. The capacity that is loaded by job is the quantity of the job,

adjusted by the throughput ratio of the item in the work cell.

The available capacity by day or week is defined by the calendar that is assigned to the work cell. The capacity

that is loaded by job is the cycle time of the activity, adjusted by the quantity (default activity quantity versus

actual job quantity) and the throughput ratio of the item in the work cell.

The Kanban job schedulingKanban job scheduling list page contains a FactBox that shows the available and booked period capacity

for the selected work cell. Depending on the selected schedule periods in the production flow model, the periods

show days or weeks.
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Tasks in the job scheduling process

Scheduling direction

Finite capacity

This article provides information about job scheduling, which is a more detailed form of scheduling than

operations scheduling. You can use job scheduling to schedule individual jobs or shop orders, and to control the

manufacturing environment.

You can use job scheduling to schedule individual jobs or shop orders, and to control the manufacturing

environment. Job scheduling breaks down each operation into its individual tasks or jobs. These jobs are then

assigned to the operations resources that will perform them. Job scheduling also lets you synchronize all jobs

that are referenced by the selected job. You can specify a start date and time or end date and time for the job,

and then run scheduling. The time that you specify can be the start time or the end time, depending on the

scheduling direction. This functionality is useful when, for example, a job can be run only on one machine at a

time, or when you want to optimize the job that is run for each resource.

The job scheduling process includes the following tasks:

Split operations into jobs.

Schedule jobs, based on the dates and times for the resources that are specified for the related operation.

Calculate start times and end times for each job. You can use finite capacity to make sure that there are no

overlapping times.

Determine which resources in the resource group to run the job on. This task requires that a resource group

be specified for an operation. Job scheduling selects the resources or resource groups based on the shortest

lead time, and also considers any previous reservations on the resources.

Explode operations into jobs when you run job scheduling. The jobs are scheduled by date and time,

according to the order that is specified by the production route. The setup of the operation determines the

jobs that are exploded during the scheduling process. The route group that is assigned to the operation

controls whether jobs are generated. A job is generated only if it has a specific duration. For example, a

transport time job is generated if a transport time was specified for the selected operation.

You can schedule jobs either forward or backward.

For wardFor ward – Use the forward scheduling direction to start the production as early as possible. This is also

known as the push method, because the production is being pushed forward through the production

process. The production is scheduled to start and end on the earliest possible dates.

BackwardBackward – Use the backward scheduling direction to start the production as late as possible. This is also

known as the pull method, because it's based on the date when the production must be completed. Backward

scheduling counts backward to the latest possible date that the production can be started without missing its

target deadline.

You can schedule jobs by using finite capacity. When you use finite capacity, the capacity that is scheduled can't

be larger than the capacity that is available for the resource. Available time is defined as the interval when the

resource is available and there are no other reservations on capacity. Scheduling that is based on finite capacity

makes sure that start times and end times for an operation on a specific date don't overlap. The resource
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capacity that is already reserved is considered, and overlaps between the start times and end times are also

considered. Finite capacity determines the amount of capacity that must be available for a resource in order to

achieve optimal use of that resource. This determination is balanced against a calculation of the shortest

possible lead time between operations.

Job scheduling that is based on finite materials makes sure that the required materials are available when the

operation starts. The coverage rules for items define these limits. Scheduling uses requirement explosion to

determine when the component items are available. If you schedule without setting finite materials, the system

assumes that all items are available when they are required.

Job scheduling that is based on special properties requires that properties be specified for the operations on the

production route. These properties must be fulfilled to reserve capacity.

Job scheduling schedules all productions that are referenced by the current production. If a production has one

or more subproductions, the subproductions should be scheduled at the same time as the main production,

because the main production can't be started until the related subproductions are completed.

The scheduling engine examines combinations of resources to identify those combinations that can satisfy

requirements. You can specify selection criteria by selecting one of the following values in the Pr imar yPrimar y

resource selectionresource selection field on the Scheduling parametersScheduling parameters  page:

DurationDuration – The scheduling engine selects the resource that has the shortest lead time. Note:Note: Scheduling by

duration can cause decreased performance when the same resource group contains many resources and

secondary operations are used. You can schedule a maximum of 32 resources per operation. If you exceed

this quantity, an Infolog message is displayed, and job scheduling doesn't find the best alternative resource.

Pr ior ityPr ior ity  – The scheduling engine selects the resource that has the highest priority if two or more resources

have identical capabilities and levels. The resource that has the lowest numeric value in this field has the

highest priority.

When job scheduling is run, the system plans the resources, based on the limitations that are defined in the

resource parameters. You can control the capacity of the resources by using calendar settings. The system

calculates loads for resources during the scheduling process. Note:Note: For productions that use the operations

scheduling function, you can run job scheduling after operations scheduling. If you aren't using operations

scheduling, you can run job scheduling alone.

Resources are assigned to jobs through job scheduling. You can establish maximum capacities for resources per

job order. For example, you can set up the system to schedule no more than 50 percent of total capacity for a

production order. This setup gives you more control over the scheduling of resources on the job scheduling

level. Therefore, it can help prevent issues if not enough capacity is available to perform simultaneous

productions.

Job scheduling considers the efficiency percentages that are specified for the resources. Efficiency percentages
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reduce or increase the time that is reserved for the resource. Therefore, lead time is also increased or decreased.

The following formula is used for the calculation: Scheduling time = Time × 100 ÷ Efficiency percentage In this

formula, Time includes both the run time and the setup time.
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Registration modes

SET  REGIST RAT IO N  M O DESET  REGIST RAT IO N  M O DE DESC RIP T IO NDESC RIP T IO N

Start Registers a Kanban transfer job as in progress.

Complete Registers a Kanban transfer job as completed.

Empty Registers the material handling unit that is referenced by a
Kanban card as empty.

Select Registers a Kanban card number and automatically selects
the referenced job in the Kanban list.

  Registration mode Select

Job status and possible actions

The Kanban transfer board supports scanner input from a widget barcode scanner to Select, Start, Complete,

and Empty a kanban job.

On the Scanner registrationScanner registration FastTab you can select the registration mode, which controls the action when you

scan a kanban card number or manually type the number in the Kanban card number field.

When you use a bar code reader to select a job, the display mode of the kanban board changes. In this mode,

the following conditions apply:

Only the scanned kanban job is displayed.

The details of the selected job are displayed in the DetailsDetails  FastTab.

The MessagesMessages  FastTab displays messages only for the selected job.

You can change the status of the job by using the functions that are available on the Action Pane. The Kanban

transfer board continues to display only a single job during this time.

You can update the information in the list of jobs manually by clicking RefreshRefresh (Shift+F5) on the Action Pane.

After you refresh the information, the full results for the job filter are displayed again.

The status of the selected job and the status of any pegged jobs for event kanbans, determine whether you can

process the job further. The following table displays information about these statuses and tasks:

The statuses that are available for jobs, or for the handling units that are referenced by the jobs.

Each task that you can perform for the job.
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This article provides information about production feedback, which gives workers feedback about production

jobs. The article includes information about the various ways that production feedback can be updated.

Production feedback gives workers feedback about production jobs. It records time and material consumption

on production orders, operation quantities and status, and errors that cause a job or operation to fail. Production

feedback can be updated in journals that are related to production orders. The Production job cardProduction job card and

Production route cardProduction route card journals are used to report time and quantities per job or operation. For reporting

about the last job or operation, quantities on the finished product can be reported as finished. Production

feedback can also be updated on the Job card terminalJob card terminal  and Job card deviceJob card device pages. These pages enable

production feedback to be updated on the shop floor and are part of the manufacturing execution functionality

in the Production controlProduction control  module. The Job card terminalJob card terminal  page has a configurable user interface that shows

a list of the released jobs in a prioritized order for a selected work area. It also offers advanced options such as

job bundling and team work. The Job card deviceJob card device page has a touch-optimized user interface. Production

feedback on both pages is updated from the production journals.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a production flow version
2/18/2021 • 2 minutes to read • Edit Online

Create a production flow

Create a production flow version

This procedure focuses on creating a new production flow version. For this procedure, the production

parameters for lean manufacturing and the units of measurement for class time must be defined. You also need

to define a value stream and a production group. To learn more about production flows and activities in lean

manufacturing, see the white papers on Lean manufacturing for Microsoft Dynamics AX. The demo data

company used to create this procedure is USMF.

1. Go to Production control > Setup > Lean production flow > Production flows.

2. Click New.

3. In the Name field, type a value.

4. In the Description field, type a value.

5. In the Name field, click the drop-down button to open the lookup.

6. In the list, click the link in the selected row.

7. In the Production group field, click the drop-down button to open the lookup.

8. In the list, click the link in the selected row.

9. Click Save.

Select an operating unit of type value stream. A value stream is an operating unit that spans all

activities and flows of the value stream. At this stage, operating units are limited to a legal entity and

have no further functionality.

Select a production group for the production flow. Production groups allow the definition of material,

labor, and WIP accounts for a production process. To associate the accounting context to a production

flow, a production group must be selected.

1. Click Add.

2. In the Expiration date field, enter a date and time.

3. Click OK.

4. In the list, mark the selected row.

5. In the Unit field, type a value.

6. ResolveChanges the Takt unit.

7. In the Average takt time field, enter a number.

8. In the Quantity per cycle field, enter a number.

9. Toggle the expansion of the Version details section.

10. In the Minimum takt time field, enter a number.

If required, define an Expiration date for the version. You can update it at any given time, even for

active versions. You can use it to plan to phase out a version.

Define the Average takt time of the version. For the takt control of the production flow version, define

a targeted average takt time. The takt is defined as quantity per time period. In the example, the takt

time is 0.2 hours per 10 pieces. For a working time of 8 hours, this corresponds to a daily throughput

capacity of 400 pieces.

Define the quantity per cycle related to the Average takt time.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/create-production-flow-version.md
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11. In the Maximum takt time field, enter a number.

12. In the Period for actual cycle time (days) field, enter a number.

13. Click Save.

Define the minimum takt time. The minimum takt time must be less than or equal to the average takt

time.

The maximum takt time must be higher than or equal to the Average takt time.

Enter the number of days in the Period for actual cycle time. The period for actual cycle time is the

number of days that jobs are aggregated from the actual minute backwards to calculate the actual

cycle time. The value can be changed at any time and is only used for the calculation of the actual cycle

times.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Find the production flow version

Create a new activity

Select the work cell

Define the inventory updates

Define the picking activities

Create a process activity for lean manufacturing.

Prerequisites:

1. A production flow and version that is not active must be created.

2. A work cell must be created.

1. Go to Production control > Setup > Lean production flow > Production flows.

2. In the list, find and select the desired record.

3. In the list, click the link in the selected row.

1. Click Activities.

2. Click Create new plan activity.

3. Click Next.

4. In the Name field, type a value.

5. In the Name field, type a value.

6. In the Process quantity field, enter a number.

7. Click Next.

Ensure that the selected production flow has a version in draft and select that version.

Note that the name must be unique for a given production flow for all versions.

Note that no matter what job quantity will be processed, this is the minimum quantity per job to

calculate the labor cost. If job quantities deviate from this quantity, labor cost variance will be created.

1. In the Work cell field, click the drop-down button to open the lookup.

2. In the list, click the link in the selected row.

1. Select or clear the Update on hand receipt check box.

If Update On hand = No, you can define the activity to receive a semi-finished product (the activity

does not reach the next BOM level). You can also select to consume semi-finished products.

1. Click Next.

2. In the list, mark the selected row.

3. Click Add.

A default picking activity is created for the input location of the selected work cell.

You can create additional picking activities for specific products, that are not staged at the work cell

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/create-process-activities-lean-manufacturing.md


Define the activity times

NOTENOTE

4. In the list, find and select the desired record.

5. In the Item number field, type a value.

6. In the Warehouse field, click the drop-down button to open the lookup.

7. In the list, find and select the desired record.

8. In the list, click the link in the selected row.

9. Select or clear the Register scrap check box.

10. Click Next.

input activity.

With this definition, all materials consumed in the activity are picked from the default input warehouse

and location except the item that is defined in the second picking activity. This item will be picked from

a different warehouse and location.

1. In the list, find and select the desired record.

2. In the Time field, enter a number.

3. In the Unit field, type a value.

4. Select the Time unit.

5. In the Per quantity field, enter a number.

6. In the list, find and select the desired record.

7. In the Time field, enter a number.

8. In the Unit field, type a value.

9. Select the Time unit.

10. In the Per quantity field, enter a number.

11. Click Next.

12. Click Finish.

13. Close the page.

The definition of a Runtime is required. The Runtime is used to calculate costs and the throughput

times of the kanban jobs. Runtimes are not used to calculate capacity load and consumption, this is

calculated by cycle time, derived from the production flow version task.

Queue times are optional.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Find the production flow version

Create a new activity

Select the Work cells

Define the inventory updates

Define the transfer locations

Create a transfer activity for lean manufacturing.

Prerequisites:

1. A production flow and version that is not active must be created.

2. The from and to warehouse and locations must be created. Optionally, the replenishing or the

replenished work cell should be created.

1. Go to Production control > Setup > Lean production flow > Production flows.

2. In the list, find and select the desired record.

3. In the list, click the link in the selected row.

Note that the production flow must have a version in draft status.

1. Click Activities.

2. Click Create new plan activity.

3. Click Next.

4. In the Name field, type a value.

5. In the Activity type field, select 'Transfer'.

6. In the Process quantity field, enter a number.

7. Click Next.

Ensure that the selected production flow has a version in draft and select that version.

1. In the Replenishing field, click the drop-down button to open the lookup.

2. In the list, click the link in the selected row.

To use the work cell output location as the from location in the transfer activity, select a work cell. The

same can be done with the replenished work cell, which sets the target location of the transfer activity.

1. In the Product type field, select an option.

Note that a transfer does not change the type of product. You can transfer finished products or semi-

finished products (transfer between two activities of a production flow and possibly a kanban flow).

When transferring finished products, you can select if picking or receiving results in an inventory

transaction.

1. Click Next.

2. In the Warehouse field, click the drop-down button to open the lookup.
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3. In the list, find and select the desired record.

4. In the list, click the link in the selected row.

5. In the Location field, click the drop-down button to open the lookup.

6. In the list, click the link in the selected row.

7. In the Freighted by field, select 'Shipper'.

8. Click Next.

Options include: Shipper - the organization operating the shipping warehouse, Recipient - the

organization operating the receiving warehouse, Carrier - a third party vendor. If the operating

organization is a vendor, the transfer activity requires a subcontracting agreement.

1. In the list, find and select the desired record.

2. In the Time field, enter a number.

3. In the Unit field, type a value.

4. Select the Time unit.

5. In the Per quantity field, enter a number.

6. In the list, find and select the desired record.

7. In the Time field, enter a number.

8. In the Unit field, type a value.

9. Select the Time unit.

10. In the Per quantity field, enter a number.

11. Click Next.

12. Click Finish.

13. Close the page.

The definition of a Runtime is required. The Runtime is used to calculate cost and the throughput

times of the kanban jobs. Runtimes are not used to calculate capacity load and consumption, which is

calculated by cycle time, derived from the production flow version task.

Queue times are optional.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a production flow

Create a production flow version

This procedure shows how to create a new production flow and a first version for lean manufacturing.

Prerequisites: The production parameters for Lean manufacturing and the units of measure for class time must

be defined. You need to define a Value stream and a Production group. Refer to the white papers on Lean

manufacturing to familiarize yourself with the concepts of production flows and activities. This procedure refers

to the legal entity USMF in demo data. However, assuming that the legal entity is configured for Lean

manufacturing, other legal entities can be used.

1. Go to Production control > Setup > Lean production flow > Production flows.

2. Click New.

3. In the Name field, type a value.

4. In the Description field, type a value.

5. In the Name field, click the drop-down button to open the lookup.

6. In the list, click the link in the selected row.

7. In the Production group field, click the drop-down button to open the lookup.

8. In the list, click the link in the selected row.

9. Click Save.

A value stream is an operating unit that spans over all activities and flows of the value stream. At this

stage, operating units are limited to a legal entity and have no further functionality.

Production groups allow the definition of material, labor, and WIP accounts for a production process.

To associate the accounting context to a production flow, a production group must be selected.

1. Click Add.

2. In the Expiration date field, enter a date and time.

3. Click OK.

4. In the list, mark the selected row.

5. In the Unit field, type a value.

6. Select the Takt unit.

7. In the Average takt time field, enter a number.

8. In the Quantity per cycle field, enter a number.

9. Expand or collapse the Version details section.

10. In the Minimum takt time field, enter a number.

11. In the Maximum takt time field, enter a number.

You can update the Expiration date of the version at any given time, even for active versions. Use the

expiration of the version to plan for a phase out of a version.

For the takt control of the production flow version, define a targeted average takt time. The takt is

defined as quantity per time period. In the given example, the takt time is 0.2 hours per 10 pieces. For

a working time of 8 hours, this corresponds to a daily throughput capacity of 400 pieces.

The minimum takt time must be less than or equal to the average takt time.

The maximum takt time must be higher than or equal to the Average takt time.
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12. Enter a number of days in the Period for actual cycle time

13. Click Save.

The period for actual cycle time is the number of days that jobs are aggregated from the actual minute

backwards to calculate the actual cycle time. The value can be changed at any time and is only used for

the calculation of the actual cycle times.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Find and activate a production flow version

NOTENOTE

Before kanban jobs can be created and activities can be processed for a production flow version, you should

activate the version. As a best practice, activate the version before its effective start date and time expire. To

complete this task, you must have a production flow version that has the Draft status in order to activate the

version.

1. Go to Production flows.

2. In the list, find and select the desired record.

3. In the list, click the link in the selected row.

4. In the list, find and select the desired record.

5. Click Activate.

6. Click OK.

Select a production flow version that has Draft in the Plan status field.

Select a production flow version that has Draft in the Plan status field.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Find the production flow version

Open the activity overview

Add a Successor

The flow of activities in a lean production flow is documented through activity relations. This recording shows

how to create an activity relation.

Prerequisites:

A production flow and version in draft mode.

Two activities that follow each other in the production flow are created but not related.

1. Go to Production control > Setup > Lean production flow > Production flows.

2. In the list, find and select the desired record.

3. In the list, click the link in the selected row.

4. In the list, mark the selected row.

5. In the list, select a draft version.

Activity relations can be added to both draft or active versions of a production flow.

1. Click Activities.

Note that the form shows all activities of the production flow that are allocated to the Version of the

production flows that you are working in.

1. Click Add successor.

2. In the Activity field, click the drop-down button to open the lookup.

3. In the list, find and select the desired record.

4. In the list, click the link in the selected row.

5. Select the Constraint check box.

6. In the Constraint value field, enter a number.

7. In the Units field, type a value.

8. In the Cycle time ratio field, enter a number.

9. Click OK.

10. Close the page.

11. Click the GridPanel tab.

12. Close the page.

13. Refresh the page.

The constraint time is the time to be scheduled between the scheduled end of the predecessor (due

date and time) and the scheduled start of the successor.

If both activities run at the same takt, the cycle time ratio should be 1. If the predecessor runs at the

double speed of the successor, the ratio should be 2. The cycle time ratios are used to calculate the

individual cycle times of the production flow activities.
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Find the production flow and version

Select an activity and add a predecessor

NOTENOTE

In a production flow version, all activities must be sequenced. An activity can have one or multiple predecessors

or successors.

This procedure shows how to associate a predecessor to an activity.

To perform this task, you need a production flow that has the Draft version with at least two activities that can be

connected.

To learn more, read the white paper "Production flows and activities in lean manufacturing."

1. Go to Production control > Setup > Lean production flow > Production flows.

2. In the list, find and select the desired record.

3. In the list, click the link in the selected row.

4. In the list, find and select the desired record.

5. Click Activities.

1. In the list, find and select the desired record.

2. Click Add predecessor.

3. In the Activity field, enter or select a value.

4. In the Cycle time ratio field, enter a number.

5. Click OK.

The default cycle time ratio of an activity relation is 1. This assumes that both activities run at the same

pace or takt time. If the predecessor runs at a higher pace (lower takt time), the ratio should be lower

than 1, if the predecessor runs at a slower pace (higher takt time) the cycle time ratio is greater than 1.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Open the form

Create a new value stream

Select a value stream manager

Save and close

NOTENOTE

Value streams are operating units, that group one or multiple production flows. To define a production flow, you

first must define a value stream.

1. Go to Production control > Setup > Lean production flow > Value streams.

1. Click New to open the drop dialog.

2. In the Name field, type a value.

1. In the Manager field, click the drop-down button to open the lookup.

2. In the list, find and select the desired record.

3. In the list, click the link in the selected row.

The value stream manager is defined to document the organization.

1. Click Save.

2. Close the page.

3. Refresh the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a sales order for a kanban controlled item

Open a pegging tree

Plan the pegging tree

NOTENOTE

This procedure focuses on validating the pegging tree from a sales line where the item is produced with

kanbans. After validating the pegging tree, all the kanban jobs are planned. This is useful for order scenarios

where the order taker needs to ensure that production can start right away. The demo data company used to

create this procedure is USMF. This procedure is intended for the advanced order taker working in a lean

company.

1. Go to All sales orders.

2. Click New.

3. In the Customer account field, enter or select a value.

4. Click OK.

5. In the Item number field, type 'L0001'.

6. Set Quantity to '30'.

Use US-001.

It is important that the quantity is higher than 24 in order to trigger the event kanban rule.

1. Click Product and supply.

2. Click View pegging tree.

Notice that the pegging tree shows all levels of the pegging needed for the sales order line. In this

case, there are two levels of kanbans and all the required components.

1. In the tree, select 'Sales line 000832\Kanban 000558'.

2. Expand the Kanban jobs section.

3. Click Plan entire pegging tree.

4. Refresh the page.

5. In the tree, select 'Sales line 000832\Kanban 000558\Issue for L0001\Kanban 000559'.

Notice that the job status for the kanban job is Not planned.

This will plan all kanban jobs in the pegging tree, changing the Job status from Not planned to

Planned.

Notice that the kanban Job status changed from Not planned to Planned.

The job for the second kanban is also planned, because the entire pegging tree is planned. Notice that

the kanban job status is changed from Not planned to Planned.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/lean-pegging-sales-orders.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a subcontracted work cell for lean
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Create a vendor resource

Create the resource group

To model subcontracted work for lean manufacturing, you must create a work cell that is associated with the

vendor that provides the work. A subcontracted work cell is linked to the vendor through the association of a

resource of the Vendor type. If you play this recording in the USMF demo company, you can select vendor

account ID 1002 and site 1.

1. Go to Resources.

2. Click New.

3. In the Resource field, type a value.

4. In the Description field, type a value.

5. In the Type field, select 'Vendor'.

6. In the Vendor field, click the drop-down button to open the lookup.

1. Go to Resource groups.

2. Click New.

3. In the Resource group field, type a value.

4. In the Description field, type a value.

5. In the Site field, click the drop-down button to open the lookup.

6. In the Site field, type a value.

7. @SysTaskRecorder :_RequestClose

8. Select or clear the Work cell check box.

9. In the Input warehouse field, click the drop-down button to open the lookup.

10. In the Input location field, click the drop-down button to open the lookup.

11. In the Output warehouse field, click the drop-down button to open the lookup.

12. In the Output location field, click the drop-down button to open the lookup.

13. Expand or collapse the Calendars section.

14. Click Add.

Select the site that the work cell should be allocated to. In theory, a site can represent a single site that

is operated by a vendor. However, in most cases, subcontracted resources are just allocated to the site

that orders the subcontracted work. Note that the input and output warehouses of subcontracted

work cells must be on the same site.

Select the warehouse and location that are used to stage the material for the vendor-managed work

cell. In many cases, the warehouse and location are modeled by using a separate warehouse per

vendor and one location per work cell.

Define the warehouse and location where the material is posted when the subcontracted activities of

the work cell are posted. The warehouse and location can be at the vendor site if the vendor reports

the kanban jobs. Alternatively, the warehouse and location can be the receiving location that is

associated with the next step of the production flow.
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15. In the Calendar field, click the drop-down button to open the lookup.

16. Expand or collapse the Resources section.

17. Click Add.

18. In the Resource field, click the drop-down button to open the lookup.

19. Expand or collapse the Work cell capacity section.

20. Click Add.

21. In the Production flow model field, click the drop-down button to open the lookup.

22. In the Capacity period field, select an option.

23. In the Average throughput quantity field, enter a number.

24. In the Unit field, click the drop-down button to open the lookup.

25. ResolveChanges the Unit.

Associate the working time calendar of the work cell with the resource group. For critical resources,

we recommend that you define specific calendars that represent the exact working times and related

capacities of the work cell or vendor site.

A subcontracted resource group must have an associated resource of the Vendor type that links the

resource group to the vendor account.

Select or enter the vendor resource that you created in the previous sub-task.

A work cell must have a defined capacity. In this example, we create a throughput capacity of 100

pieces per standard workday.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Add a kanban quantity calculation policy to a
kanban rule
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Create a kanban quantity calculation policy

Add the kanban quantity calculation policy to a kanban rule

This procedure focuses on creating a kanban quantity calculation policy and adding it to a kanban rule to

optimize the kanban size and quantities. The demo data company used to create this procedure is USMF. This

procedure is intended for the value stream manager. This procedure is a prerequisite for creating the procedure

Calculate kanban quantity suggestions.

1. Go to Production control > Periodic tasks > Kanban quantity calculation > Kanban quantity calculation

policies.

2. Click New.

3. In the Name field, type a value.

4. In the Master plan field, click the drop-down button to open the lookup.

5. In the list, find and select the desired record.

6. In the list, click the link in the selected row.

7. Click Save.

8. In the Minimum kanban quantity field, enter '1'.

9. Set Safety factor to '1'.

10. In the Days ahead field, enter '30'.

11. In the Days behind field, enter '30'.

12. Close the page.

For example, type Speaker2016.

Select StaticPlan to calculate demand.

This is the additional number of kanbans that is included in the kanban quantity calculation.

This is the factor that is used to calculate additional quantity of safety stock.

This is the number of days prior to the kanban quantity calculation date that is included in the demand

calculation.

This is the number of days forward from the kanban quantity calculation date that is included in the

demand calculation. The formula used for the calculation is shown with the actual values. For example,

Kanban quantity = ((Average daily demand x lead time x 2.00) / Product quantity per handling unit) +

1

1. Go to Product information management > Lean manufacturing > Kanban rules.

2. In the list, find and select the desired record.

3. In the list, click the link in the selected row.

4. Toggle the expansion of the Kanban quantity calculation policies section.

5. Click Add.

6. In the list, mark the selected row.

Select kanban rule 000020 for this procedure.

Add the kanban quantity calculation policy that you have just created in the previous sub-task.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/add-kanban-quantity-calculation-policy-kanban-rule.md


NOTENOTE

7. In the Name field, click the drop-down button to open the lookup.

8. In the list, click the link in the selected row.

Select the policy Speaker2016 that you have just created in the previous sub-task.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Calculate kanban quantity suggestions
2/18/2021 • 2 minutes to read • Edit Online

Create a kanban quantity calculation

Generate kanban quantity proposal

Run kanban quantity calculation

Change product quantity and calculate again

This procedure focuses on optimizing the kanban size and quantities for a specific kanban rule by using the

kanban quantity calculation. The demo data company used to create this procedure is USMF. This procedure is

intended for the value stream manager. It is a prerequisite that you have completed the procedure Add a new

kanban quantity calculation policy to a kanban rule.

1. Go to Production control > Periodic tasks > Kanban quantity calculation > Calculate kanban quantity.

2. Click New.

3. In the Name field, type 'Speaker2016'.

4. In the Name field, click the drop-down button to open the lookup.

5. In the list, click the link in the selected row.

6. In the Rule active as of date field, set the date and time to '2012-12-17T08:00:00'.

7. In the Fulfilled demand period start date field, set the date and time to '2012-11-17T09:00:00'.

8. In the Fulfilled demand period end date field, set the date and time to '2012-12-17T07:59:59'.

9. In the Demand period start date field, set the date and time to '2012-12-17T08:00:00'.

10. In the Demand period end date field, set the date and time to '2013-01-16T07:59:59'.

Select the policy that you have created in the procedure Add a new kanban quantity calculation policy

to a kanban rule. For example, Speaker2016.

This date serves as the basis for determining which fixed kanban rules are included in the kanban

quantity calculation.

The date from when past demand transactions are included to calculate the kanban quantity.

The date until when past demand transactions are included to calculate the kanban quantity.

The date from when current demand transactions are included to calculate the kanban quantity.

The date until when current demand transactions are included to calculate the kanban quantity.

1. Click Save.

2. Click Generate.

This generates a kanban quantity proposal line for the kanban rule 000020.

1. Click Calculate.

2. Click OK.

3. In the list, mark the selected row.

This calculates the kanban quantity proposal.

Notice the suggested kanban quantity is 2.

1. Set Product quantity to '5'.

2. Click Calculate.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/calculate-kanban-quantity-suggestions.md


Update kanban rule

Validate change on kanban rule

NOTENOTE

3. Click OK.

Notice that with a kanban quantity of 5, the suggestion is changed to a kanban quantity of 4.

This is caused by the fact that with a lower product quantity, we need more kanbans to fulfill the

demand.

1. In the Rule effective date field, enter a date and time.

2. Click Update.

3. Click OK.

4. Close the page.

Set the 'Rule active as of date' to a date in the future. For example, today + one year.

1. Go to Product information management > Lean manufacturing > Kanban rules.

2. In the list, click the link in the selected row.

3. Toggle the expansion of the Details section.

4. Toggle the expansion of the Quantities section.

5. Click the ListPanel tab.

Select the kanban rule that was created in the previous sub-task. This should be the first kanban rule

in the list sorted by number.

Notice the effective date, which means that this rule is not activated until this date.

Notice this is the default quantity that you entered on the kanban quantity calculation.

Notice this is the fixed kanban quantity of 4 from the kanban quantity calculation.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Change kanban rules for a process job
2/18/2021 • 2 minutes to read • Edit Online

Copy kanban rule

Change kanban rule

NOTENOTE

This procedure focuses on changing the used kanban rule for a given kanban. This is useful to level load

resources or in case of breakdown. The demo data company used to create this procedure is USMF. This

procedure is intended for the planner, working at a lean manufacturing company, responsible for the value

stream.

1. Go to Kanban rules.

2. In the list, find and select the desired record.

3. Click Duplicate kanban rule.

4. Click OK.

Select Event Kanban rule 000022 for L0001.

1. Close the page.

2. Go to Kanban job scheduling.

3. In the list, mark the selected row.

4. Click Use alternative kanban rule.

5. Click Next.

6. In the Kanban rule field, enter or select a value.

7. Click Finish.

Select line with Kanban 000177.

Select the kanban rule that was created earlier. This is the kanban rule with the highest number.

Now the kanban job is using an another kanban rule. This can be useful to level load work cells.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/change-kanban-rules-process-job.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a BOM line event kanban rule
2/18/2021 • 2 minutes to read • Edit Online

Create a new kanban rule

Create and modify a new production order

This task focuses on the setup needed to create an event kanban rule to ensure supply for production BOM lines

in a mixed lean and classic production environment. The demo data company used to create this task is USMF.

This task is intended for the process engineer or the value stream manager, as they prepare production of a new

or modified product.

1. Go to Production control > Periodic tasks > Kanban quantity calculation > Kanban rules.

2. Click New.

3. In the Type field, select 'Withdrawal'.

4. In the Replenishment strategy field, select 'Event'.

5. In the First plan activity field, enter or select a value.

6. Expand the Details section.

7. In the Product field, enter or select M0001.

8. Expand the Events section.

9. In the BOM line event field, select 'Automatic'.

10. Close the page.

The Withdrawal type is used to create transfer kanbans.

The Event strategy is selected to create the transfer of kanbans based on an event. Later in the task

guide, we will trigger it by estimating a production order.

Enter or select ReplenishSpeakerComponents. This transfer activity has receipt (output) warehouse

and location 12, which means that material will be moved to location 12 in warehouse 12.

With the BOM line event field set to Automatic, kanban will be created to fulfill material needs for

production order BOM lines.

1. Go to Production control > Production orders > All production orders.

2. Click New production order.

3. In the Item number field, enter or select a value.

4. Click Create.

5. In the list, click the link in the row for L0001

6. Click BOM.

7. In the list, click the link in the selected row.

8. Click Edit.

9. In the Line type field, select 'Pegged supply'.

10. Select No in the Resource consumption field.

11. Expand the Inventory dimensions section.

12. In the Warehouse field, type '12'.

Enter or select 'L0001'. We use item L0001 because item M0001 is included in the BOM for item

L0001.

Pegged supply is selected to trigger the supply creation of a kanban.

Clearing the check box of Resource consumption lets us change the warehouse.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/create-bom-line-event-kanban-rule.md


Estimate the production order and view the kanban created

NOTENOTE

13. In the Location field, type '12'.

14. Close the page.

15. Close the page.

Warehouse is set to 12 because this is the output warehouse for the withdrawal activity.

Location is set to 12 because this is the output location of the withdrawal activity.

1. Click Estimate.

2. Click OK.

3. Close the page.

4. Close the page.

5. Go to Product information management > Lean manufacturing > Kanban rules.

6. In the list, click the link in the selected row.

7. Expand the Kanbans section.

8. In the list, mark the selected row.

Estimating the production order will trigger the creation of the associated kanban to supply item

M0001.

Select the event kanban rule created for item M0001.

Notice the kanban created to supply M0001 for the estimated production order.

This is the last step!

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a fixed quantity kanban rule for
manufacturing
2/18/2021 • 2 minutes to read • Edit Online

Create new kanban rule

Set quantities

This procedure focuses on the setup needed to create a fixed manufacturing kanban rule for triggering

transforming activities, at a work cell, in a lean environment. The demo data company used to create this

procedure is USMF. This procedure is intended for the Process Engineer or the Value Stream Manager, as they

prepare production of a new or modified product.

1. Go to Kanban rules.

2. Click New.

3. In the First plan activity field, enter or select a value.

4. Expand the Details section.

5. In the Product field, enter or select a value.

6. In the Unit of measure field, enter or select a value.

7. In the Lead time field, enter a number.

Notice that the default Type is Manufacturing and Replenishment strategy is Fixed. You do not have to

change these parameters.

This is the activity that will be performed for kanbans created based on this kanban rule. Select

'SpeakerTestAndPackaging'.

Select L0050.

Select minutes.

Enter 5.

1. Expand the Quantities section.

2. Set Default quantity to '10'.

3. Select the Product quantity variance check box.

4. Set Variance below to '2'.

5. Set Variance above to '2'.

6. In the Fixed kanban quantity field, enter a number.

7. In the Alert boundary minimum field, enter '2'.

8. In the Alert boundary maximum field, enter '4'.

This is the quantity that will be transferred for each kanban.

With this, selected kanbans can be completed with a variance from the default quantity. To allow

kanbans to be completed with a quantity from 8 to 12, set both variances to 2.

This will allow completing down to 10 - 2 = 8

This will allow completing up to 10 + 2 = 12

This is the amount of kanbans that should be active. In this case, 5 kanbans processing 10 each.

Used to keep track of the minimum amount of full kanbans that should be at the destination. For

example, this is used on the kanban quantity overview.

Used to keep track of the maximum amount of full kanbans that should be at the destination. For

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/create-fixed-quantity-kanban-rule-manufacturing.md


Create Kanbans

NOTENOTE

9. In the Automatic planning quantity field, enter '1'.

example, this is used on the kanban quantity overview.

Setting this to 1 means that every kanban will be automatically planned. If we entered 3, the kanbans

would not be planned until 3 empty kanbans are ready for planning. This is useful for grouping work

and avoiding too much setup.

1. Expand the Kanbans section.

2. Click Save.

3. Click Add.

4. Click Create.

The kanban rule needs to be saved before kanbans can be created.

Note that there are no active kanbans, due to this the suggested 'Number of new kanbans' are 5. This

is equal to the 'Fixed kanban quantity'.

This will create 5 kanbans.

Note that 5 kanbans, for 10 each, was created for this manufacturing kanban rule. This is the last step

in this procedure.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a kanban rule using a kanban line event
2/18/2021 • 2 minutes to read • Edit Online

Create a kanban rule

Create sales order and trigger kanban chain

This procedure creates a kanban rule by using the kanban line event setting to trigger pull from a process

activity. The kanban rule is triggered by a kanban process activity, with a quantity equal to or greater than 25

each. The demo data company used to create this task is USMF. This task is intended for the process engineer or

the value stream manager, as they prepare production of a new or modified product in a lean environment.

1. Go to Product information management > Lean manufacturing > Kanban rules.

2. Click New.

3. In the Replenishment strategy field, select 'Event'.

4. In the First plan activity field, enter or select a value.

5. Expand the Details section.

6. In the Product field, type 'L0001'.

7. Expand the Events section.

8. In the Kanban line event field, select 'Automatic'.

9. Set Minimum event quantity to '25'.

10. Click Save.

This generates kanbans directly from demand. It is used to set up rules that define a make-to-order

scenario.

Enter or select SpeakerAssemblyAndPolish. The first activity of a manufacturing kanban rule is a

process activity in the production flow. When you select the activity, the validity dates of the activity

are copied to the validity dates of the kanban rule.

This generates event kanbans on demand. The field is used to configure kanban rules that replenish

material that is required for a downstream process activity. When you select Automatic, the event

kanbans are created with the demand. This setting is recommended if you expect to execute

production on the same day.

Event kanbans are generated when the demand quantity is equal to or more than this field. This is

useful if you want to produce an order quantity less than this field on one machine and more than this

field on another machine.

1. Go to Sales and marketing > Sales orders > All sales orders.

2. Click New.

3. In the Customer account field, enter or select a value.

4. Click OK.

5. In the Item number field, type 'L0001'.

6. Set Quantity to '27'.

7. In the Site field, type '1'.

Select Customer account US-003, Forest Wholesales.

L0001 is the item for which you created the kanban rule.

Because 27 is higher than the minimum quantity of 25 on the kanban rule, this will trigger an event

kanban.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/create-kanban-rule-kanban-line-event.md


View the kanban generated by the kanban rule

NOTENOTE

8. In the Warehouse field, enter or select a value.

9. Click Save.

Select warehouse 13.

1. Go to Product information management > Lean manufacturing > Kanban rules.

2. In the list, find and select the desired record.

3. Expand the Kanbans section.

Notice that a kanban for 27 was created to process the activity based on the created kanban rule.

This is the last step.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a kanban rule using a minimum stock event
2/18/2021 • 2 minutes to read • Edit Online

Create a new kanban rule

Set the minimum quantity for the item

Run the batch event creation job

This procedure focuses on the setup needed to create a kanban rule using a minimum stock event to ensure that

a specific product is always available at a specific location. A kanban rule is created to transfer material to the

location when the inventory level drops below 200 pieces. By running the Pegging event processing, the needed

kanbans are created. The demo data company used to create this task is USMF. This task is intended for the

process engineer or the value stream manager, as they prepare production of a new or modified product in a

lean environment.

1. Go to Product information management > Lean manufacturing > Kanban rules.

2. Click New.

3. In the Type field, select 'Withdrawal'.

4. In the Replenishment strategy field, select 'Event'.

5. In the First plan activity field, enter or select a value.

6. Expand the Details section.

7. In the Product field, enter or select a value.

8. Expand the Events section.

9. In the Stock replenishment event field, select 'Batch'.

This type is used to create transfer kanbans.

The Event strategy is used to create the transfer kanbans based on an event. Later in the procedure,

you will trigger transfer kanbans by using stock replenishment.

Enter or select ReplenishSpeakerComponents. This transfer activity has receipt (output) warehouse

and location 12, which means that materials will be moved to location 12 in warehouse 12.

Select M0007.

This creates kanbans to fulfill material needs at the related location during Pegging event processing.

1. Click to follow the link in the Product field.

2. Click to follow the link in the Item number field.

3. Expand the Product image FactBox.

4. On the Action Pane, click Plan.

5. Click Item coverage.

6. Click New.

7. In the list, mark the selected row.

8. In the Warehouse field, enter or select a value.

9. Set Minimum to '200'.

Set Warehouse to 12.

1. Go to Production control > Periodic tasks > Kanban job batch processing > Pegging event processing.

2. Click OK.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/create-kanban-rule-minimum-stock-event.md


NOTENOTE

3. Go to Product information management > Lean manufacturing > Kanban rules.

4. In the list, click the link in the selected row.

5. Expand the Kanbans section.

Select the kanban rule that you created earlier.

Notice that a kanban was created to transfer the needed material to warehouse 12.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a kanban rule for multiple activities
2/18/2021 • 2 minutes to read • Edit Online

Create a new kanban rule

Create kanban and view jobs

NOTENOTE

This procedure shows how to create a kanban rule that includes multiple activities from a production flow. The

demo data company used to create this task is USMF. This task is intended for the process engineer or the value

stream manager, as they prepare production of a new or modified product in a lean environment.

1. Go to Product information management > Lean manufacturing > Kanban rules.

2. Click New.

3. In the Replenishment strategy field, select 'Scheduled'.

4. In the First plan activity field, enter or select a value.

5. Select the Multiple activities check box.

6. In the Last plan activity field, enter or select a value.

7. Expand the Details section.

8. In the Product field, enter or select a value.

Select SpeakerAssemblyAndPolish.

The purpose is to include more than one activity in the kanban rule. You choose a path in the

production flow when you select the last plan activity.

Select SpeakerTestAndPackaging. After you select the value, a page automatically opens. Select the

kanban flow SpeakerAssemblyAndPolish > SpeakerTestAndPackaging. Click OK.

Select Item L0006.

1. Expand the Kanbans section.

2. Click Add.

3. In the Number of new kanbans field, enter '1'.

4. Set Product quantity to '3'.

5. In the Due date/time field, enter a date and time.

6. Click Create.

7. Click Details.

This will create one kanban.

Kanban will process 3 products.

You can enter Today.

Notice that the kanban has two process jobs from the production flow. The first one is

SpeakerAssemblyAndPolish, and the second one is SpeakerTestAndPackaging.

This is the last step!

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/create-kanban-rule-multiple-activities.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a new kanban rule by duplicating an existing
kanban rule
2/18/2021 • 2 minutes to read • Edit Online

Select a kanban rule

Duplicate a kanban rule

NOTENOTE

This procedure focuses on creating a duplicate of an existing kanban rule. This is useful if you want to create

new kanban rules based on existing kanban rules. The demo data company used to create this procedure is

USMF. This procedure is intended for the process engineer or the value stream manager as they prepare

production for a changed production flow or a new replenishment rule.

1. Go to Kanban rules.

2. In the list, find and select the desired record.

Select kanban rule 000017 for Product M0006.

1. Click Duplicate kanban rule.

2. In the Product field, enter or select a value.

3. Click OK.

When duplicating a kanban rule, it is possible to change type, dates, activities, and the product

selection. Change the product for this procedure in the next step.

Select M0007.

Note that a duplicate of kanban rule 000017 is created.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/create-new-kanban-rule-duplicating-existing-kanban-rule.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a replacement kanban rule
2/18/2021 • 2 minutes to read • Edit Online

Select a kanban rule to replace

Create a replacement kanban rule

Modify maximum quantity for the replacement kanban rule

This procedure focuses on replacing an existing kanban rule with a new kanban rule on a specific date. This is

useful when changes in the production flow or replenishment rules need to be coordinated and scheduled. The

demo data company used to create procedure is USMF. This procedure is intended for the process engineer or

the value stream manager when they prepare production for a changed production flow or a new

replenishment rule. This task replaces kanban rule 000022 with a new rule and increases the maximum quantity

from 48 to 100 for the new rule.

1. Go to Kanban rules.

2. In the list, find and select the desired record.

Select kanban rule 000022.

1. Click Replace kanban rule.

2. In the Effective date field, enter a date and time.

3. Click OK.

4. In the list, find and select the desired record.

5. In the list, select row 1.

6. In the list, click the link in the selected row.

Select a date in the future, such as one week from now. This is the date and time when the new kanban

rule becomes active and replaces the old kanban rule.

If the kanban rule changes the path in the production flow, another activity can be selected. In this

procedure, we will keep the activity untouched.

Notice that a new kanban rule is created to replace kanban rule 000022.

The effective date is set according to the date chosen when you replace the kanban rule.

Select the replaced kanban rule 000022.

Notice that the replaced kanban rule has the same date as the Expiration date because this is the date

when it will expire.

Select the new kanban rule on top of the list. This is the kanban rule with the highest kanban rule

number.

Click the kanban rule number to open the kanban rule.

1. Set Maximum quantity to '100'.

Expand the Quantities FastTab to see the Maximum quantity field. Changing the maximum quantity to

100 will allow up to 100 kanbans to be processed. This is the last step in this task.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/create-replacement-kanban-rule.md


NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a sales event kanban rule
2/18/2021 • 2 minutes to read • Edit Online

Create a new kanban rule

Define an event

Create sales line to trigger event kanban rule

This procedure focuses on the setup needed to create a kanban rule that is triggered during sales order creation.

The event kanban rule replenishes requirements that originate from sales order lines. The demo data company

used to create this procedure is USMF. It is intended for the process engineer or the value stream manager as

they prepare production of a new or modified product.

1. Go to Kanban rules.

2. Click New.

3. In the Replenishment strategy field, select 'Event'.

4. In the First plan activity field, enter or select a value.

5. Expand the Details section.

6. In the Product field, enter or select a value.

Selecting Event means that the kanban rule is triggered by an event, for example, creation of a sales

order line. This is applied to areas where each kanban should cover a specific demand.

Select Final assembly.

Select L0050.

1. Expand the Events section.

2. In the Sales event field, select 'Automatic'.

3. Set Minimum event quantity to '50'.

4. Expand the Production flow section.

By selecting the sales event Automatic, this kanban rule will be triggered automatically when a sales

line matches the product and receipt location. In this procedure, it is product L0050 on warehouse 13.

With a minimum event quantity of 50, the kanban rule will only be triggered by events with a quantity

of 50 or more.

Notice that the Receipt location is warehouse 13. This means that this kanban rule will be triggered for

this location.

In this example, a sales line for product L0050, with a quantity of 50 or more, on warehouse 13, will

trigger this kanban rule.

1. Go to All sales orders.

2. Click New.

3. In the Customer account field, enter or select a value.

4. Click OK.

5. In the Item number field, type 'L0050'.

A warning is shown when the kanban rule is saved, which means that kanbans will be created in real-

time during sales order creation.

For example, select US-003.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/create-sales-event-kanban-rule.md


Verify that kanban is created

NOTENOTE

6. In the Site field, type '1'.

7. In the Warehouse field, enter or select a value.

8. Set Quantity to '75'.

Select Site 1 because Warehouse 13 is on Site 1.

Set Warehouse to 13.

Enter a quantity of 50 or greater, to trigger the created kanban rule.

1. Click Product and supply.

2. Click View pegging tree.

Notice that a kanban with the same quantity as the sales line is created. You can also see the material

issues needed to produce L0050. This is the last step in this procedure.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create a withdrawal kanban rule
2/18/2021 • 2 minutes to read • Edit Online

Create new kanban rule

Set quantities for kanban

Create kanbans

This procedure shows the setup that is needed to create a withdrawal kanban rule for transferring material in a

lean environment. The demo data company used to create this procedure is USMF. This procedure is intended

for the Process Engineer or the Value Stream Manager, as they prepare replenishment of new or modified

material.

1. Go to Kanban rules.

2. Click New.

3. In the Type field, select 'Withdrawal'.

4. In the First plan activity field, enter or select a value.

5. In the Product field, enter or select a value.

6. In the Lead time field, enter a number.

7. In the Unit of measure field, enter or select a value.

The Withdrawal type is used for kanban rules to transfer material or goods.

Select ReplenishSpeakerComponents. This activity is set up to move components from warehouse 11,

location 11 to warehouse 12, and location 12.

Select M0007.

For example, 60.

For example, Minutes.

1. Set Default quantity to '5'.

2. In the Fixed kanban quantity field, enter '2'.

3. In the Alert boundary minimum field, enter '1'.

4. In the Alert boundary maximum field, enter '2'.

This is the quantity that will be transferred for each kanban.

This is the amount of kanbans that should be active. In this case, 2 kanbans transferring 5 each.

Used to keep track of the minimum amount of full kanbans that should be at the destination. For

example, this is used on the kanban quantity overview.

Used to keep track of the maximum amount of full kanbans that should be at the destination. For

example, this is used on the kanban quantity overview.

1. Click Save.

2. Click Add.

3. Click Create.

The kanban rule needs to be saved before kanbans can be created.

Note that there are no active kanbans because the suggested 'Number of new kanbans' is 2, which is

equal to the 'Fixed kanban quantity'.

This will create two kanbans.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/create-withdrawal-kanban-rule.md
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Note that 2 kanbans, for 5 each, was created for this withdrawal kanban rule. This is the last step in

this procedure.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Execute kanban process jobs
2/18/2021 • 2 minutes to read • Edit Online

Select a kanban job

Complete a job with expected quantity

Complete a job with errors

NOTENOTE

This procedure focuses on executing kanban process jobs. The first job is completed with the expected quantity

and has no errors. The second job is completed with errors. The demo data company used to create this

procedure is USMF. This procedure is intended for the machine operator.

1. Go to Production control > Kanban > Kanban board for process jobs.

2. In the Work cell field, click the drop-down button to open the lookup.

3. Click the row with resource group 1250. This filters the Jobs list to display only the jobs for work cell 1250.

Mark the row that has the Planned job status.

1. Expand or collapse the Details section.

2. Expand or collapse the Production instructions section.

3. Click Start.

4. Click Complete.

This section displays important information about card number, item number, quantity ordered, and

activity name.

This section displays production instructions for the activity. The instructions can be text, pictures,

drawings, and other documents.

Select a job that is not completed. Use status icons in the Job status field to view job status.

The job is completed with the expected quality.

1. Click Start.

2. On the Action Pane, click Manufacture.

3. Click Complete (details).

4. In the list, mark the selected row.

5. In the Error quantity field, enter a number.

6. In the Good quantity field, enter a number.

7. Click OK.

When a job is completed, the next job on the list is selected automatically. This is why you don't need

to select a job before you click Start.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/execute-kanban-process-jobs.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Move scheduled kanban jobs
2/18/2021 • 2 minutes to read • Edit Online

Select scheduled kanban jobs.

Move kanban jobs to a different period.

Move a job within a period.

NOTENOTE

This procedure focuses on moving planned process kanban jobs to a different period. The demo data company

used to create this procedure is USMF. This procedure is intended for the shop floor supervisor or production

planner working with kanbans.

1. Go to Production control > Kanban > Kanban job schedulingProduction control > Kanban > Kanban job scheduling.

2. In the Work cellWork cell  field, click the drop-down button to open the lookup.

3. In the list, mark the selected row.

Select work cell 1250.

4. Click SelectSelect.

5. In the Display job statusDisplay job status  field, select ScheduledScheduled. This filters the job list to display only the scheduled

kanban jobs.

1. In the list, find and select the desired record. Select a job that has the Planned jobPlanned job status, for example, a

job scheduled on December 20, 2012 in the Planned periodPlanned period field. Then move the job to the previous

period.

2. Click Previous periodPrevious period.

3. Click EndEnd to move the job to the end of the job list as the last job in the previous period.

4. In the list, find and select the desired record. Select a job that has the Planned jobPlanned job status, for example, a

job scheduled on December 18, 2012 in the Planned periodPlanned period field. Then move the job to the next period.

5. Click Next per iodNext per iod.

6. Click Star tStar t to move the job to the start of the job list as the first job in the previous period.

1. In the list, find and select the desired record. Select a job that has the Planned job status, for example, the

second job scheduled on December 19, 2012 in the Planned periodPlanned period field. Then move the job within the

planned period.

2. Click For wardFor ward. Notice that the job is moved one line down on the list.

3. Click BackwardBackward. Notice that the job is moved one line up on the list.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/move-scheduled-kanban-jobs.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Prepare a process kanban job when materials are
available for the work cell
2/18/2021 • 2 minutes to read • Edit Online

NOTENOTE

This task focuses on preparing a process kanban job when all materials are available for the work cell. The demo

data company used to create this task is USMF. This task is intended for the machine operator.

1. Go to Kanban board for process jobs.

2. In the Work cell field, click the drop-down button to open the lookup.

3. In the list, click the link in the selected row.

4. In the list, select row 4.

5. Toggle the expansion of the Picking list section.

6. Click Prepare.

Select work cell 1250 and click OK.

In the clean demo company, Kanban 000329 in row 4 is the first job that is not completed yet.

Verify that the supply status is available for all items in the picking list.

If multiple jobs are selected, the picking list will show the sum of all items needed for the selected jobs.

The preparation process is now completed. The selected check box for all rows in the picking list

indicates that the supply status is picked.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/prepare-kanban-job-materials.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Prepare a process kanban job when materials are
not available for the work cell
2/18/2021 • 2 minutes to read • Edit Online

Transfer materials to work cell

NOTENOTE

This procedure focuses on preparing a process kanban job when some materials are not available for the work

cell, therefore it's necessary to pick materials from the warehouse. The procedure "Prepare a process kanban job

when materials are available" is a prerequisite for creating this procedure. This procedure is intended for the

machine operator. The demo data company used to create this procedure is USMF.

1. Go to Production control > Kanban > Kanban board for process jobs.

2. In the Work cell field, click the drop-down button to open the lookup.

3. In the list, click the link in the selected row.

4. In the list, find and select the desired record.

5. In the list, find and select the desired record.

6. Toggle the expansion of the Picking list section.

Select work cell 1250.

Select Kanban 000356.

In the list, deselect row 4. or Select row 4 if you haven't completed the task "Prepare a process kanban

job when materials are available."

The No entry icon in the supply status indicates that 48 ea of item P0002 are missing for the work cell.

1. Toggle the expansion of the Transfer jobs section.

2. Use the Quick Filter to filter on the Item number field with a value of 'P0002'.

3. In the list, find and select the desired record.

4. Click Start.

5. Click Complete.

6. Click Prepare.

Transfer is in progress.

Item P0002 is now available in the picking list for the kanban job. This means that we can prepare the

kanban with all the needed materials.

Notice that an icon in the Job status indicates that the job is now ready.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/prepare-process-kanban-job-materials-not-available.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Remove a kanban job from the schedule
2/18/2021 • 2 minutes to read • Edit Online

Find a planned kanban job

Remove the planned kanban job from the schedule

NOTENOTE

This procedure focuses on removing a planned process kanban job from the schedule by reverting the job

status to Not planned. The demo data company used to create this procedure is USMF. This procedure is

intended for the shop floor supervisor or production planner.

1. Go to Production control > Kanban > Kanban job scheduling.

2. In the Work cell field, click the drop-down button to open the lookup.

3. In the list, click the link in the selected row.

4. Click Select.

5. In the Display job status field, select 'Scheduled'.

Select work cell 1250.

1. In the list, find and select the desired record.

2. On the Action Pane, click Plan.

3. Click Revert job status.

4. Click OK.

Select a job that has the Planned status, for example, a job from December 19, 2012.

This will revert the current job status from 'Planned' to 'Not planned' and remove it from the process

board.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/remove-kanban-job-schedule.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Revert kanban job status
2/18/2021 • 2 minutes to read • Edit Online

Open process board for the work cell

Prepare kanban job

Revert the status of the prepared kanban job

This procedure focuses on reverting an incorrect kanban job status. This is useful in case the machine operator

updates the wrong job, or sets the wrong status by mistake. In this procedure, a kanban job is registered as

prepared by mistake, and the status is reverted. The demo data company used to create this procedure is USMF.

This procedure is intended for the shop supervisor or machine operator working in a lean manufacturing

company.

1. Go to Kanban board for process jobs.

2. In the Work cell field, enter or select a value.

Select work cell 1260.

1. Click Prepare.

2. In the list, select the prepared job.

If you can't click Prepare because it is grayed out, make sure that the selected kanban job has status

Planned, which is indicated by the empty kanban icon. If Prepare fails, make sure that all materials in

the Picking list are available.

Select the first job that you have just prepared.

Notice that the jobs status is prepared, which is indicated with a triangle inside the kanban icon.

1. In the list, mark the selected row.

2. On the Action Pane, click Manufacture.

3. Click Revert status.

4. Click OK.

5. In the list, unmark the selected row.

Select the first job that was prepared.

You can use an alternative kanban rule when the following conditions are true: - The replenishment

strategy is the same for both rules. - The version of the production flow is the same for both rules. -

The product that is supplied is the same for both rules. - Any downstream activities that are

configured for the last activity of the kanban rules must be the same for both rules. - The same

supplied inventory dimensions must be configured for both rules. - The status of the handling unit

must be Not assigned. - The configuration for event kanbans must be the same.

Ensure that the new status is Planned.

Select the same job.

Notice that the job status for the kanban job is reverted to Planned, which is indicated by an empty

kanban icon.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/revert-kanban-job-status.md
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Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Schedule kanban jobs
2/18/2021 • 2 minutes to read • Edit Online

Select kanban jobs for a work cell

Schedule a kanban job in the first available period

Schedule two kanban jobs for a specific day

This procedure focuses on scheduling process kanban jobs for a specific work cell. The procedure "Prepare a

process kanban job when materials are not available" is a prerequisite for creating this procedure. The demo

data company used to create this procedure is USMF. This task is intended for the shop floor supervisor and

production planner working with kanbans.

1. Go to Production control > Kanban > Kanban job scheduling.

2. Expand the Period capacity fact box

3. In the Work cell field, click the drop-down button to open the lookup.

4. In the list, mark the selected row.

5. In the list, click the link in the selected row.

6. Click Select.

Expand the Kanban FactBox.

Select work cell 1250. This will filter the view to display only the jobs for work cell 1250.

1. In the list, mark the selected row.

2. Click Schedule.

Select the first row in the list that has the Not planned status. The dotted icon in the Job status field

indicates not planned.

This will schedule the kanban job in the first available period.

Notice that the kanban job is moved to the end of the list because it has been added to the period

starting from today.

If the period starting from today is fully booked, the job will be moved to the first available period.

1. In the list, select row 1.

2. In the list, select row 2.

3. Click Schedule from date to open the drop dialog.

4. Check or uncheck the Override capacity shortage reaction box.

5. In the Capacity shortage reaction field, select 'Add to the requested period'.

6. Click Schedule.

You should see that the first row has the Not planned status in the Job status field.

You should see that the second row has the Not planned status in the Job status field. Now you have

the first two jobs selected.

This option allows you to override the default capacity shortage reaction.

This option will ensure that the job is added to the requested period, regardless if the work cell might

be overloaded.

Notice that both jobs are added to the desired period.

In the Period capacity section, you can see the load for each period. The Consumption field shows the

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/schedule-kanban-jobs.md
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scheduled consumption in this period. If the scheduled consumption is higher than the available

capacity in this period, the overloaded consumption will be selected.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Transfer materials with kanban jobs
2/18/2021 • 2 minutes to read • Edit Online

Display transfer jobs

Start a transfer job

Select a second transfer job and change quantity

Start the second transfer job

Complete both transfer jobs

This procedure focuses on executing a withdrawal kanban job to transfer materials. The demo data company

used to create this procedure is USMF. This procedure is intended for the warehouse worker.

1. Go to Production control > Kanban > Kanban board for transfer jobs.

2. Expand or collapse the Filters section.

3. In the From warehouse field, type '11'.

4. In the To location field, type '12'.

In the Filters section, you can specify what jobs you want to see by filtering on Production flow,

Activity name, From warehouse and location, and To warehouse and location.

1. In the list, deselect the selected row - if any.

2. In the list, select row 4.

3. Click Start.

Select the first job with status Not planned. Make sure this is the only job selected.

Notice that an icon indicates that the job is started.

1. In the list, find and select the desired record.

2. In the list, find and select the desired record.

3. Note the value in the Job quantity field to reference later

4. Set Job quantity to '30'.

5. Use the value noted previously in the Job quantity field

You can have multiple jobs selected, but for now select row 5.

Make sure the job in the previous step is the only one selected. Deselect all other jobs.

Notice the warning! You are not allowed to transfer 30. According to the setup of the kanban rule, you

can only transfer the original quantity.

Set the Job quantity to the previous value.

1. Click Start.

This will start the transfer of the job in row 5.

1. In the list, select row 4.

2. Click Complete.

Now two transfer jobs are selected on row 4 and row 5.

This will complete the transfer of both jobs.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/transfer-materials-kanban-jobs.md
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Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Update kanban status
2/18/2021 • 2 minutes to read • Edit Online

Find the kanban.

Change emptied status to received status

Change received status to emptied status

NOTENOTE

When a kanban is emptied by mistake or a received kanban needs to be emptied, you need to update kanban

status. The demo data company used to create this procedure is USMF. This procedure is intended for the shop

supervisor.

1. Go to Production control > Kanban > Kanbans.

2. Open Handling unit status column filter.

3. Click Clear.

4. Use the Quick Filter to find records. For example, filter on the Card number field with a value of '000149'.

This resets the filters.

1. Click Reverse empty handling unit.

2. Click OK.

Notice that the Handling unit status is Received.

1. Click Empty kanban.

2. In the list, mark the selected row.

Notice that the Handling unit status is Emptied.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/update-kanban-status.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


    

Bills of materials and formulas
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Bills of materials

Formulas, co-products, and by-productsFormulas, co-products, and by-products

BOMs in the product lifecycleBOMs in the product lifecycle

This topic provides information about bills of materials (BOMs) and formulas, which are a central part of the

definition of products and product variants. BOMs and formulas specify the required materials or ingredients for

a specific product. Formulas also specify the co-products and by-products that are received in a specific

production context.

A bill of materials (BOM) defines the components that are required in order to produce a product. The

components can be raw materials, semi-finished products, or ingredients. In some cases, services can be

referenced in a BOM. However, BOMs typically describe the material resources that are required.

When it's combined with a route or production flow that describes the operations and resources that are

required in order to build a product, the BOM forms the foundation for calculating the estimated cost of the

product.

A BOM is an individual entity that is described by the following information:

BOM ID

BOM name

The BOM lines that describe the components and ingredients

The BOM versions, which define the product and period that the BOM can be used for

A single BOM describes a single level that is identified by a unique ID. Components might have their own BOMs

that are referenced by BOM versions. You can display and edit the complete hierarchy of BOMs for a specific

product in the BOM designer.

A formula is a subtype of BOM that is typically used for process manufacturing. In addition to components and

ingredients, a formula describes co-products and by-products. In the actual version, the definition of co-

products and by-products for the formula requires the formula version. A formula is typically defined for one

specific finished product (a formula or planning item) that is defined in the formula version.

In the product lifecycle, many types of BOM might be created for various reasons:

Sketching/Draft BOMSketching/Draft BOM – This BOM gives a draft estimation of required materials in an early design phase

and helps you do a rough estimate of cost and estimated product attributes. This BOM isn't usually used in

enterprise resource planning (ERP).

Engineering BOMEngineering BOM – This BOM is typically used when you design products that are based on existing

product portfolios. Engineering BOMs are structured to simplify the design process and group complex

products into engineering modules. For simple products, it might be possible to engineering BOMs for the

actual production process. However, for other products, the engineering BOM must be converted to an actual

production BOM. Engineering BOMS are typically represented by phantoms in the BOM hierarchy. Although

engineering BOMs can be used for the planning and execution of manufacturing operations, this approach

can lead to inefficiencies, especially in repetitive operations where many orders are created.

Planning BOMPlanning BOM – This BOM is used to do planning for material requirements. The demand of components

and ingredients is calculated based on the demand of the finished products. Like costing BOMs, planning

BOMs might represent a specific mix of material that is used in a period.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/bill-of-material-bom.md


    

Approval of BOMs and formulasApproval of BOMs and formulas

BOM and formula versions

Approval of BOM and formula versionsApproval of BOM and formula versions

Activation of the default BOM or formula versionActivation of the default BOM or formula version

Product change with case managementProduct change with case management

Alternative BOM versionsAlternative BOM versions

Production BOMProduction BOM – This is the actual BOM that is used for a specific production. A production BOM must

take into account the actual resources that are used to produce the product. When a production order, batch

order, or kanban is created, the multiple levels of BOMs that are represented by phantoms are collapsed into

one level and distributed over the operations for the order.

Costing BOMCosting BOM – This BOM is used to calculate the estimated cost of a product. For example, you can use a

costing BOM when standard cost is used or the estimated planned cost of a given product is calculated.

Costing BOMs can refer to a specific mix of materials and resources that is expected to be used. Therefore,

you can use the costing BOM to create a representative estimated cost for a period and help avoid variances

over time.

The types of BOM that are actually used in an implementation depend on the implementation, and also on the

business scenarios and requirements. In simple implementations, a planning BOM, production BOM, and costing

BOM can be modeled as one BOM. In environments that have frequent engineering changes and multiple

alternative routes, a larger set of BOM types will probably be required.

Each BOM and formula can be separately approved or unapproved. Typically, approval of a BOM or formula

occurs when the first relevant BOM version is approved. However, in some business scenarios, these approvals

might be different steps in the process and might involve different process owners.

Note that, if a BOM is unapproved, all related BOM versions are also unapproved.

To relate a specific BOM or formula to a product variant that can be produced, you must create a BOM version or

formula version. The validity of BOM versions and formula versions can be constrained by period, quantity, site,

specific product dimensions, and other criteria. Formula versions have additional important attributes, such as

yield, co-product and by-product definitions, and the cost distribution instructions for the formula.

Before a BOM version can be used in the planning or manufacturing process, it must be approved. When a BOM

version is approved, the related BOM can also be approved, depending on the user's selection and

authentication rights. Note that a BOM version can be approved only if the related BOM itself is approved.

To set a specific BOM or formula as the default BOM version or formula version that will be used by master

planning or used to create of production orders, you must activate the version. When a version is activated, the

uniqueness of the version for the given constraints (for example, period, site, or quantity) is verified. You receive

an error message if the version that you're trying to activate conflicts with a version that is already active. You

must then either inactivate the conflicting version or modify the version constraints (usually the period) to

prevent an ambiguous activation.

The product change case for approval and activation of new or changed BOMs and BOM versions provides an

easy way to see an overview of the BOM version constraints. You can also approve and activate all BOMs and

formulas that are related to a specific change for one activation date.

Sometimes, the active BOM version or formula version should not be used in forecasts, sales, or a parent

product. In this case, you can select a specific approved BOM as part of the requirement (forecast line, sales line,

or BOM line) if an approved BOM version or formula version exists for the alternative BOM or formula.

When planned orders, production orders, or kanbans are created, the planner or shop floor supervisor can use

any approved BOM version that is valid on the requested planned production date to plan for or produce a



BOM and formula lines

ItemItem

PhantomPhantom

Pegged supplyPegged supply

VendorVendor

NOTENOTE

specific product. The BOM version that is used doesn't have to be activated as the default BOM version.

A BOM line is created for each material, service, or ingredient. The line defines the planned consumption of the

specified product variant and also defines the various attributes that are related to the planned consumption.

BOM lines can have the following line types: ItemItem, PhantomPhantom, Pegged supplyPegged supply , VendorVendor .

Select the ItemItem line type for materials or services that are directly consumed, and that don't require further

explosion or pegged supply.

Select the PhantomPhantom line type when you want to explode any lower-level BOM items that are contained on the

BOM line. In Master scheduling, in planned cost calculation, or on estimation of a production order that uses

BOM lines of the PhantomPhantom type, the parent BOM line that refers to a product variant that has a phantom BOM

is replaced by the component items that are listed as BOM lines in that BOM, as determined by the applicable

active BOM version of that product variant. If the product variant has an applicable active route, the operations

of that route are merged into the parent route.

Note that phantoms are typically used to simplify the engineering process. Extensive use of phantom BOMs in

many levels has an effect on performance, especially in highly repetitive manufacturing scenarios. To improve

performance, you should avoid deep hierarchies of phantoms. Instead, use pre-exploded production BOMs and

routes.

Select the Pegged supplyPegged supply  line type when you want to create a subproduction, a BOM line event kanban, or a

direct purchase order for any product variant that the BOM line references. The subproduction, event kanban, or

purchase order is created when you estimate the production order. The required item quantities are

automatically reserved for the consuming production order.

Select the VendorVendor  line type if the production process uses a subcontractor, and you want a subproduction or

purchase order to be created automatically for the subcontractor.

Note about subcontracted operations in a BOM:Note about subcontracted operations in a BOM: The service or work that is performed by the

subcontractor must be created as service item that is tracked in inventory. You must attach the service item to

the parent item as a BOM line. The route must contain an operation that is assigned to the subcontractor's

operations resource.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Formulas and formula lines
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Item Select ItemItem when the item is a raw material or a semi-
finished item that is picked from inventory or when the item
is a service.

Phantom Select PhantomPhantom when you want to explode any lower-level
formula items that are contained on formula lines. When you
estimate the batch order, and the formula items are
exploded, the component items are listed as formula lines on
the batch order. Additionally, the corresponding routes are
added to the production route. Formula items are exploded
by using the current configuration. When you use the
PhantomPhantom line type, you can handle production and
measurement configurations that occur at different formula
levels. If you select PhantomPhantom for a product on the
EngineerEngineer  FastTab of the Released product detailsReleased product details  page
and then use this product in a formula, the line type of the
formula line is changed to PhantomPhantom. You can't select
PhantomPhantom for a catch-weight item, or for items where the
production type is Co-productCo-product , By-productBy-product , or PlanningPlanning
itemitem.

A formula defines the materials, ingredients, and outcomes of a specific process in process manufacturing.

Together with the corresponding route, the formula defines the whole process in process manufacturing.

Formulas are used to plan and produce products in process manufacturing.

A formula consists of the ingredients and quantities that are required in order to produce a specific quantity of a

formula item. Depending on the task that you perform, you can access formula functionality from Inventory and

warehouse management or Product information management.

A formula consists of one or more formula lines that identify the ingredients or items that make up the formula.

A formula line can contain Bill of materials (BOM) items, formula items, catch-weight items, purchased items, co-

products, or by-products. Because many items are used in multiple products, an item can be used in more than

one formula.

An example of a formula is the formula for a chocolate chip cookie. The ingredients for this formula use multiple

lines, such as flour, sugar, eggs, butter, and chocolate chips. The formula for the chocolate chip cookie contains

ingredients that are likely used in other formulas. While you make the chocolate chip cookies, there might be

leftovers, such as crumbs, or some of the cookies might be overbaked or undercooked. These items can be set

up as co-products or by-products, depending on the production operations.

When you create a formula line, you use the line type to indicate how the system should handle the line when

you run master planning and produce batch orders. Each line type gives a different result. The following table

describes the line types that you can select.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/formulas-versions.md


Pegged supply Select Pegged supplyPegged supply  to create a batch order, production
order, kanban, transfer order, or purchase order for the
ingredient that is contained on the formula line. The related
order is determined based on the default order settings and
the production type of the ingredient, and is created when
you estimate the batch order. The required ingredient
quantities are reserved for the batch order.

Vendor Select VendorVendor  if the production process uses a
subcontractor, and you want to create a sub-production or
purchase order for the subcontractor. The service or work
that the subcontractor performs must be created by using a
formula item or service item. You can attach the item to the
parent item as a formula line. The route must contain an
operation that is assigned to the subcontractor's operations
resource. This operation is attached to the formula line by
using the Oper. No.Oper. No.  field.
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Formula versions

Approve and activate formulas and formula versions

When you create a new formula, you must first create a formula version before you add the formula line items

and their specific characteristics. Every formula must have at least one version. The ApprovedApproved button on a

formula version becomes available only after a version record has been successfully saved. Each formula

version record is associated with one or many co-products and by-products that can be produced as you

produce the finished product. Many products can be made from the same ingredients in different batch sizes, in

multiples, or by using different yields. You can create as many versions of a formula as you require.

To manage multiple active formula versions, use effective date ranges or "from" quantity fields. Multiple active

formula versions can exist only if the date range and "from" quantity don't overlap.

Unlike BOMs, where one BOM is often associated with many BOM versions, only one formula version typically

exists per formula. Remember that only one formula version can be activated for the coverage dimensions and

quantity for a given product. However, many formula versions might exist for other reasons, and you can

manually select them when you create a batch order.

Formulas and formula versions must be approved before they can be used for planning and production.

Formulas are usually activated before they are used. However, during production, you can select a formula

version that is approved, but that isn't activated.

To help secure a formula or formula version, you can set the Block editingBlock editing and Block removal of approvalBlock removal of approval

parameters on the Production control parametersProduction control parameters  page.

If you select Block editingBlock editing, and the formula is approved, no fields on the formula lines can be deleted or edited.

However, if you remove the approval of the formula, you can delete and modify the formula lines. You can also

create new formulas and new formula versions.

If you select Block removal of approvalBlock removal of approval , you can't remove the approval of an approved formula or formula

version. However, you can create new formulas and new formula versions, and you can remove the activation of

the formula version.

You can add more levels of control by using the electronic signature functionality. When a user is set up so that

an electronic signature is required at the time of formula approval, a S ignatureSignature page appears when the formula

is activated. The user must be authorized to sign electronically, and the certificate must be successfully validated



Use the Scalable feature

Use Step consumption
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before the change can be committed. If the signature can't be authenticated, the approval or removal of

approval is denied, and the change that initiated the approval or removal of approval is returned to its original

state.

The Scalable feature is available only if all the item components in the formula are set to VariableVariable

consumptionconsumption. The feature isn't available if item components are set to Fixed consumptionFixed consumption or StepStep

consumptionconsumption. When the Scalable feature is used, if you change an ingredient in a formula, the quantity of the

other ingredients that you select is adjusted. The size of the formula is also adjusted. Likewise, if you change the

formula size, the quantity of all scalable ingredients is changed. This feature is intended specifically for formula

creation and maintenance. It doesn't indicate whether the quantity of an ingredient will be scaled up or down on

a batch order.

Step consumption eliminates the requirement that you must enter a quantity on the Formula lineFormula line tab for an

ingredient. Instead, Step consumption is configured so that it has a From ser iesFrom ser ies  value and a QuantityQuantity  value.

The information from the Step consumption per series record that satisfies the quantity on the batch order is

selected. Step consumption is useful when the consumption rate isn't linear with respect to the batch order size

and only increases the requirement when a specific quantity threshold is met. To enable this feature for a new

formula, under the Consumption calculationConsumption calculation group, change the formula setting for the applicable ingredient

from StandardStandard to StepStep. You specify this consumption method on the SetupSetup tab of the Formula lineFormula line page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Operations resources

Calendars

Resource capabilities

Operations resources perform the activities of a project or a production process. They can be of different types,

and can have different capabilities.

Operations resources are the machines, tools, workers, facilities, physical areas or vendors that perform the

activities of a project or a production process. They can be of different types and can have different capabilities.

VendorVendor  – An external resource that performs project activities or production operations. An example is a

subcontractor. By linking vendor resources to a vendor account, you can generate purchases for

subcontractors, based on the bill of materials (BOM) lines or production lines.

Human resourcesHuman resources  – A project or production worker that perform an activity, either alone or as an operator

of a tool or a machine. If you're using the Human resources functionality, you can link human resources to a

worker. The scheduling engine can then allocate the resources, based on the competencies that are defined

for the corresponding worker.

MachineMachine – A machine or other production equipment that is required in production.

ToolTool  – An instrument or device that is typically used together with another resource to perform an activity in

a project or in production.

LocationLocation – A physical location of a specific size that is required in order to perform an activity. An example is

an assembly area.

FacilityFacility  – A building or fixed structure that is required in order to perform an activity.

A calendar can be assigned to an operations resource and describes the capacity (in hours) of that resource. The

working times of the operations resource are determined by the calendar that is assigned to the resource group

that the operations resource is part of. You can set an effective date and an expiration date for the assigned

calendar. You can then assign more than one calendar to an operations resource. However, the dates of the

assigned calendars can't overlap, and the operations resource can be assigned only one calendar at a time.

Note:Note: If there are no effective working calendars for a resource group (for example, if the last assigned calendar

or the only assigned calendar has expired), you can no longer access the operations resources that are assigned

to the resource group for production planning and operations scheduling. You can also assign a calendar to a

resource group to specify the working times for both the resource group and all the operations resources that

are assigned to the resource group. The capacity of the resource group is calculated as the sum of the capacities

of each operations resource that is assigned to that resource group. The calendar that is assigned to a resource

group can change over time.

A capability is the ability of an operations resource to perform a particular activity. You can assign one or more

capabilities to an operations resource. The scheduling engine will then allocate resources by matching the

resource requirements of each activity to the capabilities of the available operations resources. Capabilities can

be assigned to all types of operations resources (ToolTool , VendorVendor , MachineMachine, Human resourcesHuman resources , LocationLocation, or

FacilityFacility ). To assign capabilities to operations resources for a limited time, define a start date and an expiration

date on the capability assignment. For more information, see Resource capabilities.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/operations-resources.md
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Resource scheduling

A resource group is a set of operations resources that represents the granularity at which you want to schedule

resources when you use the operations scheduling method. Therefore, resource groups typically correspond to

the physical organization of work cells that is demarcated by yellow lines on the production shop floor. The

resource group defines the site, production unit, and warehouse context for operations resources that are

assigned to the group. When you assign an operations resource to a resource group, the resource can be

scheduled at the site where the resource group is located. You don't have to assign the operations resources that

you create to a resource group. However, an operations resource must be assigned to a resource group before it

can be scheduled to perform work. An operations resource can be assigned to a resource group for a limited

time. You can also assign an operations resource to multiple resource groups, so that you can then share the

resource across sites. However, the effective dates and expiration dates can't overlap. In other words, you can't

assign an operations resource to two resource groups at the same time. Changes in resource group

assignments are effective only for new resource allocations. Capacity reservations for jobs, operations, and

project hour forecasts that are already scheduled won't be affected. Note:Note: When you assign operations

resources of the VendorVendor  type to a resource group, all operations resources that are assigned to that resource

group must be of the VendorVendor  type and must be linked to the same vendor account.

A production unit is an administrative unit that is a collection of resource groups. A production unit can contain

multiple resource groups, but a resource group can be assigned to only one production unit. A production unit

reflects the physical layout of production resources, and has no effect on transactions or how they are

processed. You must associate a production unit with a site. You can also assign a picking warehouse and a

storage warehouse to a production unit. You can use a production unit to consolidate and filter production-

related data. For example, a shop floor manager can see an overview of the outstanding workload and the

available capacity for a particular production unit. You can change the production unit that is assigned to a

resource group. You can also delete a production unit. However, these changes to the production unit are

effective only for new orders that are created after master scheduling is run. If you want to apply the production

unit change to existing orders, you must make this change manually.

Operations resources are assigned to activities when a project or a production is scheduled. Two scheduling

methods are available: operations scheduling and job scheduling. When you use operations scheduling, each

operation or project activity is scheduled on the resource group that contains operations resources that match

the resource requirements that are specified for the operation. If a specific operations resource is required for

the operation, scheduling reserves capacity only on a specific operations resource in the group. Job scheduling

is a more detailed form of scheduling than operations scheduling. It breaks down each operation into its

individual tasks or jobs. These jobs are then assigned to the operations resources that will perform them.

Scheduling reserves capacity on the resource groups, based on the operation times that are defined on the

production route or project activities. If you're working with finite capacity, the schedule depends on the

availability of the operations resources that are required in order to complete the activity. For operations

scheduling, the capacity of the resource group is the sum of the available capacity of the operations resources

that are part of that group. Capacity reservations that already exist for the operations resources are considered

unavailable capacity. If there isn't enough available capacity for production, the production orders can be

delayed or even stopped. On the ResourcesResources  page, you can define several properties that control how capacity

reservations are made:

CapacityCapacity  – Specify the operations resource's capacity per hour in terms of the capacity unit of measure.

Batch capacityBatch capacity  – Specify the maximum number of pieces that the operations resource can process per run.

Efficiency percentageEfficiency percentage – Specify the efficiency that you expect from the operations resource. The efficiency

percentage adjusts the throughput of the operations resource and affects the time that is reserved for the



Lean work cells

Costing resources

resource. The lead times for the operations that use the operations resource are also adjusted accordingly.

Here is the formula that is used for the calculation: Scheduling time = Time × 100 ÷ Efficiency percentage.

Time includes both the run time and setup time.

Operations scheduling percentageOperations scheduling percentage – Specify the maximum percentage of capacity of the operations

resource that you want to use in operations scheduling. To allow for flexibility in capacity during job

scheduling, you should set this percentage to less than 100 percent.

Finite capacityFinite capacity  – Set this option to YesYes  if the operations resource should be scheduled based on the actual

capacity that is available, and if existing capacity reservations should be considered. If this option is set to NoNo,

the operations resource is assumed to have infinite capacity, and the resource might therefore be

overbooked.

Finite proper tyFinite proper ty  – Set this option to YesYes  if you want the operations resource to be scheduled based on the

actual capacity that is available with respect to the required working time scheduling properties.

ExclusiveExclusive – Set this option to YesYes  if you don't want the operations resource to be available for another job or

operation until the current production is completed. In this case, the operations resource can't be used even if

there are gaps in the resource's run time.

Bottleneck resourceBottleneck resource – Define the operations resource as a bottleneck resource. A bottleneck resource is

scheduled by using finite capacity when the Finite capacityFinite capacity  and Bottleneck schedulingBottleneck scheduling options on the

Master plansMaster plans  page are selected.

To schedule multiple operations resources at the same time to perform, for example, an operation in production,

you must specify the requirements for the various resources by using primary and secondary operations. You

can then also reserve multiple operations resources that have different capacity. The operations resource that

are scheduled for the primary operation determine the duration of the activity.

You can specify that a resource group is a lean work cell. The resource group can then be part of a production

flow. By specifying a resource group as a lean work cell, you also prevent the resource group and the assigned

operations resources from being allocated to the operations of a production order or a project hour forecast. For

each resource group that acts as a lean work cell, you must specify the following information:

CalendarCalendar  – The working calendar of the work cell, which must have the property of a standard workday.

Input warehouse and locationInput warehouse and location – The default location that is used to pick material for an activity.

Output warehouse and locationOutput warehouse and location – The default location where all output of the work cell is put.

Runtime cost categor yRuntime cost categor y  – This category must be defined for the work cell if direct labor is tracked in

costing.

When a resource group is used as a lean work cell, the capacity of the work cell is specified directly on the

resource group. Therefore, you don't have to assign operations resources to the resource group. Only when the

work cell is managed by a subcontractor, an operations resource of the VendorVendor  type must be assigned to the

work cell. If you assign an operations resource to a resource group that is marked as a work cell, the capacity of

the work cell isn't affected.

When you define an activity such as a route operation or a project hour forecast, you can specify the

requirement for a specific operations resource or resource group. However, you can also specify the

requirement for an operations resource of a specific type, or an operations resource that has a specific capability

or competency. For this reason, the actual resource assignment isn't made until the activity is scheduled and

capacity is reserved. Therefore, on a route operation, you can specify that estimation and BOM calculation must

be based on a specific operations resource. This operations resource is referred to as the costing resource. You

can also transfer cost categories and operation times from the costing resource to the activity. When the

operation is scheduled, estimation and BOM calculation are done by using the operations resource that is
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actually scheduled.
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Level

Priority

Resource requirements

This article provides information about resource capabilities. A capability is the ability of an operations resource

to perform a particular activity. The article explains how capabilities and related concepts, such as proficiency

level and priority, are used to select appropriate resources for an activity.

A capability is the ability of an operations resource to perform a particular activity. An operations resource can

have more than one capability assigned to it, and a capability can be assigned to more than one resource. You

can temporarily assign capabilities to resources by defining a start date and expiration date on the capability

assignment. When the capability for a resource expires, the resource can't be scheduled for a project or a

production that requires that capability. A capability that has expired can be renewed. You can delete capabilities,

provided that they aren't on a route relation or on part of a production route of an active production order. In

general, be careful when you delete capabilities. Instead, consider adjusting the expiration date on the resources

that have the capability. Capabilities can be assigned to all types of resources: tool, vendor, machine, location,

facility, or human resource.

Multiple resources often have the same functional capability but at different levels of proficiency (for example,

strength, processing speed, or accuracy). Therefore, when you assign a capability to a resource, you can specify a

LevelLevel  value. The level is a simple numeric value. If you specify that a capability is a resource requirement for a

production route, you can also specify a Minimum level neededMinimum level needed value for that capability. The scheduling

engine then selects only resources that have the required capability at a level that is equal to or exceeds the

minimum level that is specified in the resource requirement.

Operations resources that have the same capabilities can be assigned a priority. Then, if multiple resources have

capabilities that satisfy the scheduling requirements at the required level, and have free capacity, the scheduling

engine can select among those resources. If Pr ior ityPr ior ity  is selected in the Pr imar y resource selectionPrimar y resource selection field on

the Scheduling parametersScheduling parameters  page, the resource that has the highest priority (the lowest numeric value in the

Prior ityPr ior ity  field) is selected first during scheduling.

When you define resource requirements for a production route, you can specify one or more capabilities as

requirements. During production scheduling, the capabilities that are defined in the resource requirements on

the route operation are matched with the capabilities that are defined for the resources. Resources that have

capabilities that satisfy the requirements are selected. If multiple resources have the same functional capability

but different proficiencies (such as strength, processing speed, or accuracy), you can either define multiple

capabilities or use the capability level to qualify the capability of the resource. Here is an example:

On a route, the drilling process time is set to 10 units per hour, but the requirement itself is defined as

Drilling.

You have two drilling machines, M1 and M2.

The Drilling capability is assigned to both resources, the M1 machine and the M2 machine.

The M1 machine can drill two units per hour, and the M2 machine can drill 11 units per hour.

In this example, both machines can be selected by the scheduling engine, because both satisfy the basic

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/resource-capabilities.md
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capability requirement (Drilling). However, the M1 machine can drill only two units per hour. Because this rate is

much less than the 10 units per hour that are specified on the route, the M1 machine will cause production

problems if it's selected. There are two ways to resolve this issue and make sure that the M2 machine is selected

instead:

Create two separate capabilities: Low-speed drilling and High speed drilling. Define Low-speed drilling as

drilling that has a process time of one to nine units per hour. Define High-speed drilling as drilling that has a

drilling process time of 10 to 19 units per hour. Then assign the M1 machine the Low-speed drilling

capability, and assign the M2 machine the High-speed drilling capability. Finally, change the resource

capability requirement on the route to High-speed drilling. The scheduling engine will then select the correct

machine (M2).

Use the capability level to qualify the Drilling capability that is assigned to the drilling machines. Specify that

the M1 machine has the Drilling capability at a level of 2.0, and that the M2 machine has the Drilling

capability at a level of 11.0. Then specify that 10.0 is the minimum level that is required for the Drilling

capability requirement on the route. The scheduling engine will then determine that only the M2 machine

satisfies the resource requirements.

When you have operations resources of the Human resourcesHuman resources  type that are linked to workers in Human

resources, you can also take advantage of the competencies of workers when you define the resource

requirements for a production route. In other words, you can also specify requirements for specific skills,

courses, certificates, or titles. The scheduling engine can then select resources that are linked to workers, and the

selection will be based on the competencies of those workers. The competencies are set up in Human resources,

not on the Resource capabilitiesResource capabilities  page. When you define skills, courses, certificates, or titles as resource

requirements, you must use the Human resources functionality and link each resource of the HumanHuman

resourcesresources  type to a corresponding worker. If you aren't using the Human resources functionality, you can

define capabilities on the Resource capabilitiesResource capabilities  page that resemble or duplicate the competencies from

Human resources. However, the Resource capabilitiesResource capabilities  page doesn't contain the functionality that is required

in order to maintain skills, courses, certifications, or titles.
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Assign batch attributes

Reserve batches

This topic provides information about batch attributes. Batch attributes are characteristics of raw materials and

finished products that make up inventory batches. The topic also explains how to assign batch attributes, and

how you can search on them when you reserve batches.

Batch attributes are characteristics of raw materials and finished products that make up inventory batches. Batch

attributes can vary, depending on factors such as environmental conditions, the quality of the raw materials that

are used to produce the batch, or the outcome of the finished product. The number and types of batch attributes

that are used can vary widely from one industry to another. Here are two examples that show how to use batch

attributes:

In the cheese industry, milk, which is one of the raw materials that are used to produce the cheese, can have

attributes such as fat content and percentage weight. The cheese that is produced from the milk can have

other attributes, such as moisture and age.

In the steel industry, the iron that is produced might have attributes such as the percentages of magnesium

content, silver content, and zinc content.

To better manage the number and types of attributes, you can use batch attribute groups. In this way, you don't

have to add each attribute individually.

You can assign batch attributes to individual products that are held in inventory batches, or you can assign them

to products that are associated with specific customers. Before you can assign a batch attribute at the customer

level, you must assign it at the product level. The product must have the batch dimension set to ActiveActive in the

tracking dimension group. To assign a batch attribute to an individual product, use the product-specific page. If

the attribute is specific to a product for a customer, use the customer-specific page. When you add an attribute

to a product, you also define other parameters. Here are some examples:

The minimum and maximum ranges for an attribute of the IntegerInteger  or FractionFraction type.

The tolerance actions for an attribute of the IntegerInteger  or FractionFraction type. If the value of the attribute falls

outside the minimum and maximum range, the action can be either a warning message or an error message.

The target value for the attribute. This value is the optimal value of the attribute, and it applies to all attribute

types.

You can access the pages for products that you select on the Released productsReleased products  page in Product information

management. After you assign batch attributes to a product, you can add specific values to the attributes on the

Inventor y batch attr ibutesInventor y batch attr ibutes  page.

You can search on batch attributes when you do batch reservations for a sales order to fulfill a customer's order,

or when you pick and reserve batches for a production order. The search helps locate an inventory batch that

contains the product that has the batch attribute that you want. After you locate the batch or batches, you can

reserve the product to the originating inventory transaction line.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/batch-attributes.md
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Products that have an active ingredient

Ingredient types and how they interact in the batch balancing
process

This topic describes how the batch balancing process is supported.

For more information, watch a video on batch balancing.

In the batch balancing process, the amount of ingredients to use in a production batch is calculated from the

concentration of active ingredients in selected product batches.

A product can be defined by its concentration of an active ingredient. The active ingredient of a product is

modeled by using a product-specific batch attribute that has a minimum value, a maximum value, and a target

level.

The target level of a batch attribute represents the estimated percentage of an active ingredient in a product. The

minimum and maximum values represent the accepted deviation from the target level. They can be used, for

example, as an accepted tolerance for batches at product receipt.

A product can have only one active ingredient. To specify the active ingredient of a product, you must first define

a product-specific batch attribute. You then associate the attribute as a base attribute of the product.

On the product level, you must also specify how the level of the active ingredient for a batch of the product

should be recorded: as part of the purchase receipt process or as part of a quality order process.

To associate a base attribute with a product, the following setup is required:

The product must be batch-controlled. To make a product batch-controlled, you must assign a tracking

dimension group to the product that has an active Batch dimension.

The attribute that indicates the ingredient levels must be defined as a product-specific batch attribute for

the product.

To look up and edit the actual value of the active ingredient for a batch:

1. Go to Inventor y management > Inquir ies and repor ts > Tracking dimensions > BatchesInventor y management > Inquir ies and repor ts > Tracking dimensions > Batches .

2. Select a batch number from the grid.

3. On the Action Pane, open the ViewView  tab and then select Inventor y batch attr ibutesInventor y batch attr ibutes .

A formula line that is created can have one of these ingredient types:

None

Active

Compensating

Filler

The rest of this section provides examples that show how each ingredient type works. The examples are based

on the following formula that has a total batch size of 100 liters.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/batch-balancing.md
https://www.youtube.com/watch?v=4SNLWsU9KyI&feature=youtu.be
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None A 20 Liter

Active B 30 Liter

Compensating C 10 Liter

Filler D 40 Liter
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A None 20 20 Liter

B Active 30 25.71 9.00 Liter 30.00

C Compensatin
g

10 14.72 Liter

D Filler 40 39.57 Liter

Active ingredientsActive ingredients

Active ingredient exampleActive ingredient example

None ingredientsNone ingredients

None ingredient exampleNone ingredient example

Compensating ingredientsCompensating ingredients

The following table provides an overview of the results of each example.

When a product that has a base attribute is added to a formula line, it's referred to as an active ingredient of the

formula. Batch orders that have formulas that include active ingredients can be used for the batch balancing

process. For each ingredient in the formula, the batch balancing process estimates the amount that is required

to produce the product. The estimate of amounts is based on the concentration of active ingredients in the

selected batches.

Ingredient B has base attribute X and a target level of 30, and it's included in a formula that requires 30 liters of

ingredient B for every 100 liters of the product. A batch order is created that has a batch size of 100 liters. The

batch order is started, and during the batch balancing process, the user selects a batch of ingredient B that has a

potency level of 35. Because the potency level of 35 is higher than the target level of 30, the balanced quantity of

ingredient B is reduced by using the ratio of the potency value to the target level of the batch, which is

multiplied by the estimated quantity. The calculation of the balanced quantity looks like this:

(30 ÷ 35) × 30 liters = 25.71 liters

When you apply the batch balancing process when the Ingredient typeIngredient type is None, the estimated quantity and

the balanced quantity of the formula line in the batch order are the same.

Ingredient A is assigned to an ingredient of the None type and added to a formula for a finished product. The

formula requires 10 liters of ingredient A for every 100 liters of the finished product. When a batch order

requires 200 liters, both the estimated quantity and the balanced quantity of ingredient A are calculated as 20

liters.

A compensating ingredient can either offset or complement the effect of the active ingredient in a product.

Therefore, the quantity of a compensating ingredient that is consumed depends on the potency of the product:



Compensating ingredient exampleCompensating ingredient example

Filler ingredientsFiller ingredients

Filler ingredient exampleFiller ingredient example

Opposing effectOpposing effect – If the amount of the active ingredient is more than anticipated, you must add less of

the compensating ingredient.

Complementar y effectComplementar y effect – If the amount of the active ingredient is less than anticipated, you must add

more of the compensating ingredient.

The relation between an active ingredient and a complementary ingredient is set up on the CompensatingCompensating

principleprinciple page.

Follow these steps to set up relations between ingredients.

1. Select Product information management > Bills and mater ials and formulas > FormulasProduct information management > Bills and mater ials and formulas > Formulas .

2. Open a formula line, and then select IngredientsIngredients  to open the Compensating pr incipleCompensating pr inciple page.

3. Select the line that represents a compensating principle, and then select the active ingredient to compensate.

In the compensating principle, you also enter a positive or negative compensating factor to specify how much to

compensate for, and whether the principle should be opposing or complementary. A positive factor indicates a

complementary effect, and a negative factor indicates an opposing effect.

Ingredient B is an active ingredient that has base attribute X and a target level of 30. It's included in a formula

that requires 30 liters of ingredient B for every 100 liters of the product. Ingredient C is a compensating

ingredient, and a quantity of 10 is included in the same formula. A compensating factor of 1.10 is set up for the

compensating principle. Therefore, the balanced quantity of the compensating ingredient will be reduced by the

difference between the active ingredient's balanced quantity and the estimated required quantity multiplied by

1.10.

In the example for the Active ingredient type, the balanced quantity of the required active ingredient was

calculated as 25.71, and the estimated required quantity was calculated as 30. In this case, the balanced quantity

of the compensating ingredient will be calculated like this:

1. The difference between the estimated and the balanced quantity is determined:

25.71 – 30 = –4.29

2. The result is multiplied by the compensating factor :

4.29 × 1.10 = –4.72

3. The estimated compensating quantity is reduced by –4.72 to determine the balanced compensating

quantity:

10 – (–4.72) = 14.72

Because 1.10 is a positive compensating factor, this compensating principle has a complementary effect. In this

case, the active ingredient is more potent than anticipated. Therefore, more of the compensating ingredient is

required.

A filler ingredient is a neutral ingredient that is used to reach the desired output quantity of the finished product.

Adjustments to filler quantities are calculated based on variations in the active ingredient and the compensating

ingredient compared to the standard quantity.

You've formulated a product that includes ingredients A, B, C, and D for a formula size of 100 liters. You've

calculated the balanced quantity of all the ingredient types except the Filler ingredient type that is used on one

line. The balanced quantity of the filler ingredient is calculated as the difference between the batch size of 100

liters and the sum of ingredients A, B, and C:

100 – (20 + 25.71 + 14.72) = 39.57



The batch balancing process

Balance batch ingredientsBalance batch ingredients

NOTENOTE

Confirm and release the formulaConfirm and release the formula

Batch orders that aren't applicable for batch balancingBatch orders that aren't applicable for batch balancing

The batch balancing process is performed from the Batch balancingBatch balancing page. Select Cost management >Cost management >

Batch ordersBatch orders , and then, on the ProcessProcess  tab, select Batch balancingBatch balancing. Batch balancing is available for batch

orders that have a status of Star tedStar ted.

In general, batch balancing can be applied to batch orders if the formula has at least one formula line where the

Ingredient typeIngredient type is Active. (For the exception to this rule, see the "Batch orders that aren't applicable for batch

balancing" section later in this topic.)

The batch balancing process can be divided into two subprocesses:

1. Balance batch ingredients

2. Confirm and release the formula

In the Balance batch ingredients subprocess, the amount of ingredients to use for the production batch is

calculated based on the selected batches that have active ingredients. As a rule, the calculation can be completed

only if there is full coverage of all ingredients. You can't balance only part of the batch that the batch order is set

up to produce.

You can't save a calculation and then complete the batch balancing process later. If you close the Batch balancingBatch balancing page,

you must repeat the calculation to complete the process.

After the ingredient quantities have been calculated, you can confirm and release the formula. The release

process differs, depending on whether the products are enabled for the warehouse management processes:
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If a product is enabled for the warehouse management processes, the formula line is released to the

warehouse according to the principles for the warehouse management processes. The formula line is

released in quantities that match the balanced quantities, and it's released for the specific batches that are

selected for the active ingredients.

Formula lines can be released to warehouse only as part of the batch balancing process. Although there are other

options for releasing materials for production to warehouse, those options can't be used for formula lines.

If a product isn't enabled for the warehouse management processes, a production picking list is created

for the product when you confirm and release the formula.

In a single formula, you can combine products that are enabled for the warehouse management processes and

products that aren't enabled for the warehouse management processes. When the two types of products are

included in one formula, the products that are enabled for the warehouse management processes are released

to warehouse. For the products that aren't enabled for the warehouse management processes, a picking list is

created when the formula is confirmed and released.

There are two exceptions to the rule that batch orders are applicable for batch balancing if the formula has at

least one formula line where the Ingredient typeIngredient type is Active.

1. If a formula contains an active ingredient for a product that is enabled for the warehouse management

processes, but batch number is below location in the reservation hierarchy, the batch order isn't applicable



NOTENOTE

for batch balancing.

2. If the formula unit of measure is different from the inventory unit of measure of the active ingredient, the

batch order isn't applicable for batch balancing.

A batch order that isn't applicable for batch balancing goes through the regular process cycle for batch orders.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Feature exposure
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Transaction adjustments

NOTENOTE

To use warehouse management to process catch weight products, you must use a license configuration key to

turn on the functionality. Go to System administration > Setup > L icense configurationSystem administration > Setup > L icense configuration. Then, on the

Configuration keysConfiguration keys  tab, expand Trade > Warehouse and Transpor tation managementTrade > Warehouse and Transpor tation management, and select the

check box for Catch weight for warehouseCatch weight for warehouse.

Both the Warehouse and Transpor tation managementWarehouse and Transpor tation management  license configuration key and the Process distribution >Process distribution >

Catch weightCatch weight  license configuration keys must also be turned on. To set the configuration keys for catch weight, you

must also turn on the feature by using the Feature managementFeature management  workspace. The main feature that must be turned on

is Catch weight product processing with warehouse managementCatch weight product processing with warehouse management . Two related but optional features that you

might want to turn on are Inventor y status changes for catch weight productsInventor y status changes for catch weight products  and Use existing catch weightUse existing catch weight

tags when repor ting production orders as finishedtags when repor ting production orders as finished.

After the license configuration key is turned on, when you create a released product, you can select CatchCatch

weightweight. You can also associate the released product with a storage dimension group that the Use warehouseUse warehouse

management processesmanagement processes  parameter is selected for.

Before you can use the product in Warehouse management, you must do some basic product-specific setup for

catch weight:

Define the nominal weight conversion between the catch weight unit (box) and the inventory unit (kilogram

[kg]) as part of a unit conversion definition.

Define the minimum and maximum weight tolerances as part of the catch weight unit setup.

Set up a unit sequence group where the catch weight unit is defined as the lowest stock keeping unit (SKU).

Set up a catch weight item handling policy.

For more information, see Setting up and maintaining catch weight items.

Because the weight of inventory when it comes into a warehouse can differ from the weight when the inventory

is issued out of the warehouse, the catch weight product processing must adjust the inventory.

Mobile device activity will trigger the transaction adjustments only if the Outbound weight variance method of the item's

catch weight item handling policy is Allow weight varianceAllow weight variance.

Example 1Example 1

During a Repor t as finishedRepor t as finished production process, the inbound weight of a license plate that contains eight

boxes of a catch weight product is captured as 80.1 kg. The license plate is then stored away in the finished

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/catch-weight-processing.md
https://docs.microsoft.com/en-us/dynamicsax-2012/appuser-itpro/setting-up-and-maintaining-catch-weight-items


Catch weight item handling policy
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goods area, and during the storage period, some weight is lost into the air.

Later, as part of a sales order picking process, the weight of the same license plate is captured as 79.8 kg.

Therefore, in the system, you now have a weight difference as part of the physical dimension set.

In this case, the system automatically adjusts the difference by posting a transaction for the missing 0.3 kg.

Example 2Example 2

In its definition, a product is set up to tolerate a minimum weight of 8 kg and a maximum weight of 12 kg for

the BoxBox catch weight unit.

You have two boxes of the product, and they have a registered weight of 16 kg. If a warehouse worker picks and

weighs one of the boxes, and the weight is captured as 9 kg, the remaining box will weigh 7 kg. However,

because 7 kg is below the minimum weight, the system does an automatic adjustment to increase the weight of

the on-hand inventory by 1 kg.

To set up the accounts that these adjustments are posted to, go to Cost management > Ledger integrationCost management > Ledger integration

policies setup > Postingpolicies setup > Posting. Then, on the Inventor yInventor y  tab, define the following accounts:

Catch weight loss account

Catch weight profit account

The catch weight item handling policy defines two primary warehouse management flows for the items: when

the weight of the items is captured, and how it's captured.

You can define when the weight is captured for sales and transfer order processing. The weight can be captured

during either of the following processes:

PickingPicking – The weight is captured during the initial pick work lines of order work.

PackingPacking – The weight is captured during manual packing. (You must send the items to a packing station.)

If the actual weight is captured at the packing station during the container packing processes, warehouse

workers aren't prompted to capture the weight during picking work. Instead, the average weight of the physical

inventory is used as the weight of the picked inventory that goes to the packing area. This concept also applies

to catch weight items that are tracked by tags. For tag-tracked items, these parameters determine when the tag

is captured. The tag can be captured either at picking time by using the mobile device or during manual packing.

Because the PackingPacking option causes inventory to be updated with the average picked weight, this could trigger a

discrepancy that could cause a catch weight profit/loss adjustment and/or a difference between on-hand inventory weight

and catch weight tag weight.

For internal warehouse management processes such as counting and adjustment corrections, you can define

whether the weight should be captured. If it isn't captured, the nominal weight is used. Other options let you

capture weight per catch weight unit and per counting quantity.

You can also define how the weight is captured. In one of the two main flows, catch weight tags are tracked and

used to capture the weight. In the other flow, catch weight tags aren't tracked.

YesYes  – The item uses catch weight tags. Each tag number represents one catch weight unit (box), and a weight

and other information are associated with the tag. For outbound processes, the weight that is associated with

the tag is used.

NoNo – The item doesn't use catch weight tags. The inbound and outbound weighing processes are based on
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How to capture catch weightHow to capture catch weight

the actual weight that is captured during each process.

The process of tracking catch weight tags can be used for items that won't change weight during the storage

period. The weight will be captured only during the inbound warehouse process. During the outbound process,

the catch weight tags will just be scanned, and the weights that are associated with the tags will be used for the

outbound transactional processing.

Another important parameter that is related to the processing of catch weight tags is Catch weight tagCatch weight tag

dimension tracking methoddimension tracking method. Tags can be either partially tracked or fully tracked. If a tag is partially tracked, it

tracks product dimensions, tracking dimensions, and inventory status. If a tag is fully tracked, it tracks product

dimensions, tracking dimensions, and allall  storage dimensions.

Additionally, when an item is tag-tracked, there is an Outbound tag capturing methodOutbound tag capturing method parameter. You can

set this parameter so that you're always prompted for the tag on outbound transactions from the mobile device.

Alternatively, you can set the parameter so that you're prompted for tags only when they are required. For

example, there are five catch weight tags in inventory on a given license plate, and you've indicated that you

want to pick all five tags from the license plate. In this case, if the Outbound tag capturing methodOutbound tag capturing method

parameter is set to Only prompt for tag when neededOnly prompt for tag when needed, the five tags are automatically picked. You don't have

to scan each tag. If the parameter is set to Always prompt for tagAlways prompt for tag, you must scan each tag, even if all five tags

are being picked.

As a rule, tags are captured and updated only from the mobile device menu items. Nevertheless, there are a few scenarios

where tags are captured somewhere else (for example, from the manual packing station). However, in general, the mobile

device menu items should be used for all warehouse activity if tags are used.

When catch weight tag tracking is usedWhen catch weight tag tracking is used, a tag must always be created for every catch weight unit that is

received, and every tag must always be associated with a weight.

For example, BoxBox is the catch weight unit, and you receive one pallet of eight boxes. In this case, eight unique

catch weight tags must be created, and a weight must be associated with each tag. Depending on the inbound

catch weight tag, either the weight of all eight boxes can be captured, and the average weight can then be

distributed to each box, or a unique weight can be captured for each box. When using the Use existing catchUse existing catch

weight tags when repor ting production orders as finishedweight tags when repor ting production orders as finished feature with the process enabled via a mobile

device menu item, the inventory gets updated based on existing catch weight tag information. As a result, the

warehouse app does not prompt for capturing the catch weight tag data as part of a production report as a

finished operation.

When catch weight tag tracking isn't usedWhen catch weight tag tracking isn't used, the weight can be captured for each dimension set (for

example, for each license plate and tracking dimension). Alternatively, the weight can be captured based on an

aggregated level, such as five license plates (pallets).

For the methods for capturing outbound weight, the Per catch weight unitPer catch weight unit option lets you specify that the

weighing should be done for each catch weight unit (for example, per box). The Per picking unitPer picking unit option lets

you specify that the weight should be captured based on the quantity that will be picked (for example, three

boxes). Note that for the production line picking and internal movement processes, the average weight will be

used if the Not capturedNot captured option is used.

Multiple weight capturing methods are defined on the catch weight item handling policy. Each weight capturing

method parameter is used by various transactions. The following table summarizes which parameters are used

by which transactions.
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Outbound weight capturing method Sales picking, Transfer picking

Production picking weight capturing method Production picking, Production consumption

Movement weight capturing method Movement

When to capture correction of weight Adjustments, Counting

Counting weight capturing method Counting

Warehouse transfer weight capturing method Warehouse transfer

Unsupported scenarios

Configuring catch weight products for warehouse management processesConfiguring catch weight products for warehouse management processes

Order processingOrder processing

Inbound warehouse processingInbound warehouse processing

To prevent the warehouse management picking processes from capturing weights that cause catch weight

profit/loss adjustments, you can use the Outbound weight variance method. The Outbound weight variance

method applies during the following mobile device processes: sales picking, transfer picking, production picking,

movements, counting, and warehouse transfers. You can use the Restr ict weight var ianceRestr ict weight var iance option if the weight

of the catch weight item doesn't fluctuate during warehouse storage, and if catch weight profit/loss adjustments

aren't required. You can use the Allow weight var ianceAllow weight var iance option if the weight can fluctuate, and if catch weight

profit/loss adjustments are required when a weight fluctuation is recorded.

Not all workflows support catch weight product processing with warehouse management. The following

restrictions currently apply. They apply to all catch weight items, regardless of whether they are tagged.

Only formula processing is supported for catch weight products (not bill of materials).

Catch weight products can't be associated with a tracking dimension group by using the Owner dimension.

Catch weight products can't be used as services.

Catch weight products can be used as "stocked products" only as part the item model group.

Catch weight products can't be used together with the functionality for tracking "Active in sales process."

Catch weight products can't be used together with the functionality for capturing serial numbers. Therefore,

products can't be transferred from a "blank" to a serial number as part of the picking/packing process.

Catch weight products can't be used together with the functionality for registering serials before

consumption.

Catch weight products that are variant-enabled can't be used together with the functionality for converting

variant units of measure.

Catch weight products can't be marked as a commerce "product kit."

Catch weight products can be used only with a unit sequence group that has catch weight handling units, and

that has the catch weight unit as the lowest sequence.

For catch weight products, the inventory unit can be converted to the catch weight unit only if the conversion

produces a nominal quantity that is more than 1.

The setup of bar codes for catch weight products doesn't support a variable weight setup.

The creation of advance ship notice (ASN/packing structures) doesn't support weight information.

The order quantity must be maintained based on the catch weight unit.



Inventory and warehouse operationsInventory and warehouse operations

Outbound warehouse processingOutbound warehouse processing

Production processingProduction processing

Transportation management processingTransportation management processing

Other restrictions and behaviors for catch weight product processing with warehouse managementOther restrictions and behaviors for catch weight product processing with warehouse management

Catch weight tagsCatch weight tags

Receiving license plates requires that weights be assigned during registration, because weight information

isn't supported as part of the advance ship notice. When catch weight tag processes are used, the tag

number must be manually assigned per catch weight unit.

Inbound quality check work isn't supported for catch weight products. If configured, the quality check work

will be skipped.

Manual creation of quarantine orders isn't supported for catch weight products.

Manual movement of inventory that is related to open work isn't supported for catch weight products.

License plate loading to initialize warehouse stock isn't supported for catch weight products.

Batch balancing processes aren't supported for catch weight products.

Handling of negative physical inventory isn't supported for catch weight products.

Inventory marking can't be used for catch weight products.

The functionality for cluster picking isn't supported for catch weight products.

Pick and pack warehouse processing isn't supported for catch weight products.

For catch weight products, work that is defined in a work template cannot be run automatically.

For catch weight products, the system doesn't support manual packing station processing where packed

container picking work is created after containers are closed.

The functionality for pcs-by-pcs scanning isn't supported for catch weight products.

For catch weight products, only batch orders for formula products are supported.

Kanban functionality isn't supported for catch weight products.

For catch weight products, serial numbers can't be registered before consumption.

The functionality for reversing license plates from production isn't supported for catch weight products.

For catch weight products, reporting as finished can't be registered by serial number.

Load building workbench processing isn't supported for catch weight products.

Transport request lines aren't supported for catch weight products.

During picking processes where the user isn't prompted to identify tracking dimensions, the weight

assignment is done based on the average weight. This behavior occurs when, for example, a combination of

tracking dimensions is used in the same location and, after a user processes picking, only one tracking

dimension value is left in the location.

When inventory is reserved for a catch weight product that is configured for warehouse management

processes, the reservation is done based on the minimum weight that is defined, even if this quantity is the

on-hand last handling quantity. This behavior differs from the behavior for items that aren't configured for

warehouse management processes. There is one exception to this restriction. For production picking, when

the last handling quantity of a catch weight product that is serial number–controlled is picked, the actual

weight is used.

Processes that use the weight as part of capacity calculations (wave thresholds, work maximum breaks,

container maximums, location load capacities, and so on) don't use the actual weight of the inventory.

Instead, the processes are based on the physical handling weight that is defined for the product.

In general, Commerce functionality isn't supported for catch weight products.

For catch weight products, inventory status can't be updated from Warehouse status changeWarehouse status change.
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A catch weight tag can be created by using a warehouse app process, it can be manually created in the form, or

it can be created by using a data entity process. If a catch weight tag is associated with an inbound source

document line, such as purchase order line, the tag will be registered. If the line is used for outbound processing,

the tag will be updated as shipped.

In addition to the restrictions that currently apply for catch weight products, tagged catch weight products have

other restrictions that currently apply.

All manual updates to inventory (that is, updates that aren't done using a mobile device) must include

corresponding manual updates to the associated catch weight tags because these updates aren't done

automatically. For example, manual adjustment journals will update inventory but not the associated catch

weight tags.

You must manually update catch weight tags to reflect replenishment work movements. This is because the

system can't capture weights while processing replenishment work and therefore records the average weight

instead.

Mixed licensing place receiving isn't currently supported for tagged catch weight items.

The processing of sales return order receiving can record catch weight tags. However, the process doesn't

validate that the returned tag is the same tag that was originally shipped for a sales order.

The mobile device menu item that has the Register mater ial consumptionRegister mater ial consumption activity code doesn't currently

support recording catch weight tags.

Although counting processes are supported for tagged catch weight items, they are limited. For example, you

can use the mobile device options for counting tagged catch weight items, and the average weight is used.

However, catch weight tags aren't automatically updated by the counting transaction. After the counting

transaction is completed, the catch weight tags must be manually updated so that they reflect the inventory.

If items that weren't originally in a location are counted into that location, the nominal weight is used.

License plate consolidation doesn't currently support tagged catch weight items.

Reverse work functionality isn't supported for catch weight items that are tag number–tracked.

The preceding information about catch weight tags is valid only if the catch weight product has a catch weight tag

dimension tracking method that is fully tracked (that is, if the Catch weight tag dimension tracking methodCatch weight tag dimension tracking method

parameter on the catch weight item handling policy is set to Product dimensions, tracking dimensions and allProduct dimensions, tracking dimensions and all

storage dimensionsstorage dimensions). If the catch weight item is only partially tag-tracked (that is, if the Catch weight tagCatch weight tag

dimension tracking methoddimension tracking method parameter on the catch weight item handling policy is set to Product dimensions,Product dimensions,

tracking dimensions and Inventor y Statustracking dimensions and Inventor y Status), additional restrictions apply. Because visibility is lost between the tag

and inventory in this case, some additional scenarios aren't supported.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a formula

Copy formula lines

Adjust copied formula lines

Approve formula

This procedure focuses on creating a formula that includes the same ingredients as an existing formula, but with

minor differences. To create the formula lines, you can use the Copy function to copy an existing formula that

has most of the ingredients that you need. You can then make any necessary changes to the individual lines in

the new version. By using the Copy function, you do not have to create multiple formulas that are almost

identical. The demo data company used to create this task is USP2.

1. Go to Product information management > Bills of materials and formulas > Formulas.

2. Click New.

3. In the Formula field, type a value.

4. In the Name field, type a value.

5. In the Site field, click the drop-down button to open the lookup.

6. In the list, click the link in the selected row.

7. In the Item group field, click the drop-down button to open the lookup.

8. In the list, find and select the desired record.

9. In the list, click the link in the selected row.

10. Click Save.

Type a meaningful name for the formula.

1. On the Action Pane, click Formula.

2. Click Copy.

3. In the Item number field, click the drop-down button to open the lookup.

4. In the list, click the link in the selected row.

5. In the Formula version field, click the drop-down button to open the lookup.

6. In the list, click the link in the selected row.

7. Click OK.

1. In the list, mark the selected row.

2. Click Delete.

3. Click Yes.

1. On the Action Pane, click Formula.

2. Click Approve formula.

3. In the Approved by field, click the drop-down button to open the lookup.

4. In the list, click the link in the selected row.

5. Click Select.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/tasks/copy-formula.md
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6. Click OK.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Select a released product

Copy co-products
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This procedure shows how to copy co-products from an existing formula version to a different formula version

for a released product. It is a prerequisite that there is at least one formula version associated with co-products.

The demo data company USP2 is used to create this procedure.

1. Go to Released products.

2. Click Show filters.

3. Click Add a filter field to add the field Production type.

4. Manually enter Formula in the Production type field.

5. Click Apply.

You are about to add the field Production type in the filter dialog box.

In the next step, you need to manually enter Formula in the Production type field before you select

Apply. This sets the filter on the list of released products.

1. In the list, find and select the desired record.

2. Click Formula versions.

On the Engineering Action Pane, click Formula versions.

1. On the Action Pane, click Formula version.

2. Click Co-products.

3. Click Copy.

4. In the Item number field, enter or select a value.

5. In the Formula version field, enter or select a value.

6. Click OK.

7. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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This procedure shows how to quickly create a new formula by copying from an existing formula. You can use the

demo data companies USMF, USP2, or USPI to create this procedure.

1. Go to Formulas.

2. Click New.

3. In the Formula field, type a value.

4. In the Name field, type a value.

5. In the Site field, enter or select a value.

6. In the Item group field, enter or select a value.

7. Click Save.

1. Click Copy.

2. In the Item number field, enter or select a value.

3. In the Formula version field, enter or select a value.

4. Click OK.

1. In the list, find and select the desired record.

2. Click Delete.

3. Click Yes.

1. Click Approve formula.

2. In the Approved by field, enter or select a value.

3. Click OK.

4. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Types of production jobs

IMPORTANTIMPORTANT

This topic provides information about the setup of production parameters in Manufacturing execution.

The Manufactur ing executionManufactur ing execution module is intended primarily for manufacturing companies. It can be used to

register time and item consumption on production jobs or projects. Before you start to use Manufacturing

execution for job registrations, you must set up various production parameters that define how and when

registrations are posted during the production process. The settings of production parameters affect inventory

management, production management, and cost calculation.

Before workers start to make registrations on production jobs, you should carefully consider all settings on the

Production parametersProduction parameters  page. Click Production controlProduction control  > SetupSetup > Manufactur ing executionManufactur ing execution >

Production order defaultsProduction order defaults . If your company uses the multisite functionality, you might want to set up

different production parameters for each site. The parameters for integration with the ProductionProduction module are

set up on the following tabs on the Production parametersProduction parameters  page:

GeneralGeneral  – General parameter settings for production jobs in Manufacturing execution.

Star tStar t – Parameters that are used when production operations are started.

OperationsOperations  – Parameters that are applied to production operations and feedback about operations during

the production process.

Repor t as finishedRepor t as finished – Parameters that are used when items are reported as finished on the last operation of

a production order.

Quantity validationQuantity validation – Parameters that are used to validate start and feedback quantities on production

orders.

On the OperationsOperations  tab, you select which types of production jobs require registration on the Job registrationJob registration

page.

Typically, workers make registrations on setup jobs and process jobs. However, if job scheduling is applied, you

can select other job types that workers must make registrations on when production orders are processed. For

example, you can require registrations on transport jobs.

Make sure that you select all relevant job types. Otherwise, jobs might not be available for registration on the JobJob

registrationregistration page. Your selections should match the selections in the Job managementJob management  column on the SetupSetup tab of

the Route groupsRoute groups page (Production controlProduction control > SetupSetup > RoutesRoutes > Route groupsRoute groups).

If Job managementJob management is selected on the route group, this job type is reported as finished on the production

order when the job is reported as finished in Manufacturing execution. When all job types that JobJob

managementmanagement is selected for have been reported as finished on an operation, Manufacturing execution reports

the operation as finished.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/production-parameters-manufacturing-execution.md


NOTENOTE

BOM consumption and picking list journals

Some job types can be manually reported through production journals. In this case, select Job managementJob management  for the job

type, but don't select the job type for registration on the OperationsOperations tab on the Production parametersProduction parameters  page in

Manufacturing execution.

A consistent setup for bill of materials (BOM) consumption is important, because it helps guarantee that

inventory management is efficient. For example, if BOM consumption parameters aren't set up correctly in

Manufacturing execution, materials might be deducted from inventory two times or not at all.

On the Production parametersProduction parameters  page, automatic BOM consumption is set up in three stages:

At the start of a production. Set up this stage on the Star tStar t tab.

During the production process when an operation is completed. Set up this stage on the OperationsOperations  tab.

When a production order is reported as finished. Set up this stage on the Repor t as finishedRepor t as finished tab.

For each stage, the Automatic BOM consumptionAutomatic BOM consumption field lets you select one of three methods for picking items

for a production order :

Flushing pr incipleFlushing pr inciple – This option is used in combination with an option that is defined for the BOM in

the ProductionProduction module. Click Production controlProduction control  > CommonCommon > Production ordersProduction orders  > AllAll

production ordersproduction orders . On the All production ordersAll production orders  page, select a production order in the list, and then,

on the Action Pane, click BOMBOM. On the BOMBOM page, on the SetupSetup tab, in Flushing pr incipleFlushing pr inciple field, select

one of the following options:

NOTENOTE

Star tStar t

FinishFinish

ManualManual

Blank (No option is selected.)

Available at locationAvailable at location

In Manufacturing execution, if Flushing pr incipleFlushing pr inciple is selected in the Automatic BOMAutomatic BOM

consumptionconsumption field on the Star tStar t tab, all materials that are set to Star tStar t in the BOM are deducted

from inventory when the operation is started. The Available at locationAvailable at location option is used for

products that are enabled for advanced warehouse processes. If you select this flushing principle,

material is flushed when warehouse work for raw material picking is completed. Material is also

flushed when a BOM line that uses this flushing principle is released to warehouse and the

material is available at the production input location.

If the Flushing principleFlushing principle field is set on the Star tStar t  tab in Manufacturing execution, you must select the

same principle on either the OperationsOperations tab or the Repor t as finishedRepor t as finished tab. This requirement helps

guarantee that materials are deducted from inventory on BOMs that use FinishFinish as a flushing principle on

the production order. If the same flushing principle isn't selected on either the OperationsOperations tab or the

Repor t as finishedRepor t as finished tab, materials might be deducted from inventory two times.

AlwaysAlways  – If you select this option for a stage, materials are always deducted from inventory at that stage.

For example, materials for the production are deducted when the production order is started. This setting

requires that NeverNever  be selected on the OperationsOperations  and Repor t as finishedRepor t as finished tabs. This requirement



IMPORTANTIMPORTANT

Example 1: Backflushing on operationsExample 1: Backflushing on operations

TA BTA B F IEL DF IEL D SET T IN GSET T IN G

Start Update start on-line StatusStatus or Status + quantityStatus + quantity

Start Automatic BOM consumption NeverNever

Operations Automatic BOM consumption AlwaysAlways

Report as finished Automatic BOM consumption NeverNever

Report as finished Update finished report on-line Status + quantityStatus + quantity

Example 2: Backflushing on productionExample 2: Backflushing on production

TA BTA B F IEL DF IEL D SET T IN GSET T IN G

Start Update start on-line StatusStatus or Status + quantityStatus + quantity

Start Automatic BOM consumption NeverNever

Operations Automatic BOM consumption NeverNever

Report as finished Automatic BOM consumption AlwaysAlways

Report as finished Update finished report on-line Status + quantityStatus + quantity

Example 3: Flushing principleExample 3: Flushing principle

helps prevent items from being deducted from inventory two times.

NeverNever  – If you select this option for a stage, no BOM consumption occurs at that stage. For example, if

you select NeverNever  on all three tabs (Star tStar t, OperationsOperations , and Repor t as finishedRepor t as finished), materials must be

manually deducted from inventory.

Carefully consider your setup of the production parameters, and make sure that the parameters that are selected on the

various tabs of the Production parametersProduction parameters  page don't contradict each other.

The following examples illustrate parameter settings that support various BOM consumption principles. The

parameters are set up on the Production parametersProduction parameters  page in Manufacturing execution.

Use the following settings if picking list journals and BOM item consumption should be generated when items

are reported as finished on an operation.

Use the following settings if picking list journals and BOM item consumption should be generated when items

are reported as finished on the production order.

Use the following settings if picking list journals and BOM item consumption should be generated according to

the flushing principle that is set for the BOM items.



TA BTA B F IEL DF IEL D SET T IN GSET T IN G

Start Update start on-line Status + quantityStatus + quantity

Start Automatic BOM consumption Flushing principleFlushing principle

Operations Automatic BOM consumption Flushing principleFlushing principle

Report as finished Automatic BOM consumption NeverNever

Report as finished Update finished report on-line Status + quantityStatus + quantity

Example 4: Deduction of materials during startup of a production orderExample 4: Deduction of materials during startup of a production order

TA BTA B F IEL DF IEL D SET T IN GSET T IN G

Start Update start on-line Status + quantityStatus + quantity

Start Automatic BOM consumption AlwaysAlways

Operations Automatic BOM consumption NeverNever

Report as finished Automatic BOM consumption NeverNever

Report as finished Update finished report on-line StatusStatus or Status + quantityStatus + quantity

Example 5: Manual BOM consumptionExample 5: Manual BOM consumption

TA BTA B F IEL DF IEL D SET T IN GSET T IN G

Start Update start on-line StatusStatus

Start Automatic BOM consumption NeverNever

Operations Automatic BOM consumption NeverNever

Report as finished Automatic BOM consumption NeverNever

Report as finished Update finished report on-line StatusStatus

Use the following settings if picking list journals and BOM item consumption should be generated when a

production is started.

Based on the selections that are described earlier in this section, picking list journals are posted at various stages

of the production order process:

When an operation is started

When quantity feedback is reported on an operation

When items are reported as finished on the production order

You can use the following settings if materials should always be manually deducted from inventory. In this case,

picking list journals aren't posted.
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Required baseline setup in other modules

Required calendar and resource setup

Required production parameters setup

Required journal name identification

This article provides information about setup requirements before you can work with Production control.

Production control is integrated with features in other modules. This interconnectivity lets you change

production orders and make sure that they are automatically updated in all other related processes and

calculations in the system. The following setup processes are listed in the order that you should complete them

in.

Information in other modules must be set up before you can work with Production control. This setup includes

the following tasks:

Set up general company information.

Set up the general ledger.

Define item groups.

Set up ledger accounts for item groups.

Set up the inventory item table in Inventory management.

Create bills of materials (BOMs) and BOM versions in Inventory management.

Before you use Production control, open Organization administration, and create and define the calendar and

operations resources in the following order :

1. Working time templatesWorking time templates  – Set up working time templates to define the times that are available for

production scheduling.

2. CalendarsCalendars  – Set up working time calendars to define the days of the year that are available for production

scheduling.

3. Resource groupsResource groups  – Set up resource groups to group the operations resources, so that you can get an

overview of any free capacity when you run scheduling. You don't have to set up resource groups before you

set up operations resources. However, we recommend that you understand how to group resources when

you set up Production control.

4. ResourcesResources  – Set up operations resources to define the resources that are used to complete the production

process and plan for capacity.

Production control parametersProduction control parameters  – Set up basic production parameters to define how the system handles and

processes production orders. Define how production orders are created, estimated, scheduled, and consumed.

You can also select what kind of feedback you want and how cost accounting is done.

Production journal namesProduction journal names  – Specify the production journal names that are used to record and post

transactions.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/production-set-up-requirements.md


Setup if you use operations

Setup if you use routes

Optional advanced settings

NOTENOTE

Operations represent the specific activities that are completed to produce the finished product. Note:Note: You must

know the types of activities that are required in order to produce your item, and the order and priorities of those

activities. You must also know which resources are involved, and how many.

1. OperationsOperations  – Set up operations to represent the tasks that must be completed to produce the finished item.

2. RelationsRelations  – Set up operation relations to establish detailed properties. To define operation relations, click

RelationsRelations  on the OperationsOperations  page.

If you're working with routes, operations must be defined for every production route that you set up. The route

represents the path that the item takes from operation to operation, from the start of the production process to

the end.

1. Cost categoriesCost categories  – Set up cost categories to define the cost per hour of specified processes and setup times.

2. Cost groupsCost groups  – Set up cost groups to create and maintain different types of costing.

3. Route groupsRoute groups  – Set up route groups to define parameters that are related to groups of routes. You must set

up route groups before you can create production routes.

4. RoutesRoutes  – Set up production routes, and define default settings to control scheduling, costing, and pricing of

route operations, and to control progress reporting.

5. Route versionRoute version – Set up route versions to enable item variations in production.

1. Production groupsProduction groups  – Set up production groups to establish relationships between the production order

and ledger accounts. The ledger accounts are used to post or group orders for reporting.

2. Production poolsProduction pools  – Create production pools to group production orders so that you can process urgent

production orders, or delete and post groups of orders.

3. Proper tiesProper ties  – Define properties to create special attributes that you can assign to your resources to control

the order of productions. These attributes are connected to the working time template.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Components of operations scheduling

Scheduling direction and date

This topic provides information about operations scheduling. You can use operations scheduling to provide a

general estimate of the production process over time.

You can schedule production at the operation level and the job level. Unlike job scheduling, operations

scheduling doesn't explode the operations for the production route into jobs. If you want to include more detail

in the scheduling, such as information about current capacity, you can run job scheduling after you run

operations scheduling. You can also run job scheduling only. Job scheduling is typically used to schedule

individual jobs on the shop floor for an immediate or short-term time frame.

The main components of operations scheduling are the scheduling direction, the capacity of resources, and

materials optimization. By using operations scheduling, you can achieve the following goals:

Control the planning method by scheduling forward or backward from a given date.

Optimize the use of resources by scheduling productions based on the capacity of the resources. This

approach also helps identify when alternative resources should be used.

Optimize the use of materials by scheduling productions based on the availability of the required materials.

Schedule and synchronize reference productions. The dates of the reference productions are adjusted when

the production order ’s schedule is changed.

You must estimate the cost of a production order before you can run operations scheduling. If you haven't run

an estimate, it's automatically run before operations scheduling is started. An operations schedule specifies the

following information:

The product that is planned for production

The configuration of the product

The quantities that are involved in the production

The dates when the production will start and end

The capacity reservations for the resources that perform the production activities

The setup time, process time, and run time are set for operations in the production. After you run operations

scheduling, the status of the production order is ScheduledScheduled, and all operations are scheduled in the order that

is specified by the production route. However, only the duration of the operation is considered. Start times and

end times aren't scheduled.

The scheduling direction is fundamental to the scheduling process. Production can be scheduled forward or

backward from any date, depending on timing and scheduling requirements.

For ward from the scheduling dateFor ward from the scheduling date – You can schedule production to start as early as possible.

Production can be started today, tomorrow, or on any date in the future. The production is scheduled forward

in time to the earliest possible end date.

Backward from the scheduling dateBackward from the scheduling date – You can schedule production to start as late as possible. Backward

scheduling is based on the date when the production must be completed. The schedule counts backward

from that date to the latest possible date that the production can be started and still be completed on time.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/operations-scheduling.md


Resource scheduling

Operations scheduling and master planning

NOTENOTE

Cancellations

Finite materials

Additional resources

NOTENOTE

When you run an operations schedule, each operation in the production route is scheduled for the resource that

is specified for the operation. Additionally, the duration of each operation is specified on the production route. If

a resource group is specified for an operation, the scheduling reserves capacity on the group. However, unlike

job scheduling, operations scheduling doesn't select the specific resources in the group. If you're working with

finite capacity, the schedule depends on the availability of the resources that are required in order to complete

production. Operations scheduling follows the sequence of operations that is specified on the production route.

The scheduling reserves capacity on the resource groups, based on the operation times that are defined on the

production route. The sum of available capacity on the resources that are involved determines the capacity for

the resource group. Capacity reservations that already exist for the resources are considered unavailable

capacity. If there isn't enough available capacity for the production, the production orders can be delayed or

even stopped. You can also specify the efficiency that you expect from the resources that are involved in the

production. You specify the efficiency as a percentage on the resource. The efficiency percentage adjusts the

throughput of the resource. This adjustment affects the time that is reserved for the resource. The lead times for

the operations that use the resource are also adjusted accordingly.

The operations schedule also drives master planning and determines calculations for material requirements.

Operations scheduling considers the following information:

Backlogged productionsBacklogged productions  – Products that are planned, released, or started

Material availabilityMater ial availability  – Inventory, subproductions, suppliers, and vendors

Capacity availabilityCapacity availability  – Resources that are required for production

If you're using multi-threaded master planning and operations scheduling, finite capacity will not be considered.

When you run operations scheduling, you can cancel specific parts of the routing. These parts include the queue

time, setup time, process time, overlap time, and transport times.

If you're working with finite materials, scheduling also depends on the availability of the materials that are

required for production. If there aren't enough available components for the production, production can be

delayed. You can base scheduling on the use of materials by specifying the materials that must be available for

production. When you optimize on both resource capacity and the availability of materials, production is

calculated according to these restrictions. A production order can't be scheduled to start until capacity and

materials are available at the same time and in the required quantities.

Operations scheduling options

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Operations scheduling
Scheduling directionScheduling direction

This topic describes the options for operations scheduling. You can use operations scheduling to provide a

general estimate of the production process over time.

Operations scheduling calculates the following information for a production order :

Start and end dates are set for the production order and each operation.

Resources are assigned to operations.

Several settings determine how production schedules are calculated. You define these settings on the

Operations schedulingOperations scheduling page. The following information describes the scheduling options.

The scheduling direction is fundamental to the scheduling process. A production can be scheduled forward or

backward from any date, depending on timing and scheduling requirements.

For ward schedulingFor ward scheduling – You can schedule a production to start as early as possible. The production can be

started today, tomorrow, or on any specific date in the future. The production is scheduled to start on the

earliest possible date and is planned forward in time to the earliest possible end date.

Backward schedulingBackward scheduling – You can schedule a production to start as late as possible. The schedule is based on

the date when the production must be completed and counts backward to the latest possible date that the

production can be started without missing its target deadline.

The following options are available:

For ward from todayFor ward from today  – Schedule forward from the current date. (The current date is the system date.)

For ward from planned star tFor ward from planned star t – Schedule forward from an earlier start date. If there is no previous

scheduling, the scheduling direction is forward from the current date.

For ward from scheduling dateFor ward from scheduling date – Schedule forward from the date that is specified in the SchedulingScheduling

datedate field. If you don't specify a scheduling date, the scheduling direction is forward from the current date.

Backward from deliver y dateBackward from deliver y date – Schedule backward from the delivery date that is specified for the

production order. If you select this option, but no delivery date is specified, the delivery date is the current

date.

Backward from planned endBackward from planned end – Schedule backward from a previously calculated end date. If there is no

previous scheduling, the end date is the current date.

Backward from scheduling dateBackward from scheduling date – Schedule backward from the date that is specified in the SchedulingScheduling

datedate field. If you don't specify a scheduling date, the current date is used. Backward from scheduling date is

calculated for the production order the last time that a requirement was calculated. If no date is specified for

the production order, the current system date is used.

Backward from futures dateBackward from futures date – Schedule backward from the futures date that was calculated for the

production order the last time that a requirement was calculated. If no futures date is specified for the

production order, the current system date is used.

As last schedulingAs last scheduling – For operations scheduling and job scheduling, the selected scheduling direction and

date are saved. Therefore, you can select this option for subsequent scheduling. If there is no previous

scheduling of the production order, scheduling is backward from the current system date.

For ward from tomorrowFor ward from tomorrow  – Schedule forward from the current date plus one day.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/operation-scheduling-options.md


Scheduling dateScheduling date

Recalculate BOM levelsRecalculate BOM levels

Limitations
Finite capacityFinite capacity

Finite materialFinite material

For ward from previous jobFor ward from previous job – This option is relevant only in job scheduling. If you select this scheduling

direction for operations scheduling, the production order is scheduled forward from the current date. In job

scheduling, scheduling is established for one job, and all other jobs for the production are scheduled based

on that job.

Backward from previous jobBackward from previous job – This option is relevant only in job scheduling. If you select this scheduling

direction for operations scheduling, planned orders are scheduled backward from the current date. In job

scheduling, scheduling is established for one job, and all other jobs for the production are scheduled based

on that job.

This date is used for the For ward from scheduling dateFor ward from scheduling date and Backward from scheduling dateBackward from scheduling date scheduling

directions. Scheduling is backward or forward from this date. For more information, see the previous section,

"Scheduling direction."

When you select Recalculate BOM levelsRecalculate BOM levels , the selected bill of materials (BOM) levels will be recalculated to

help guarantee the correct scheduling order.

Scheduling depends on the availability of the resources that are required in order to complete production. If

there isn't enough capacity, production orders can be delayed or even stopped. If finite capacity is applied to

operations scheduling, existing capacity reservations that are made on the resources are considered, and that

capacity is seen as unavailable. The production order is scheduled based on the availability of capacity on the

resources that are required. Operations scheduling uses the specified sequence of operations to determine the

order of operations in the production route. Operations scheduling reserves capacity on the resource groups,

based on the operation times that are defined on the production route. The capacity of the resource groups is

the sum of available capacity on all the resources in the resource groups.

Scheduling also depends on the availability of the materials that are required for production. Insufficient

component availability can also cause production delays. Scheduling can also be based on the use of materials.

Just specify the materials that must be available for production instead of the materials that aren't critical. This

type of scheduling is known as scheduling with finite material. When you specify finite materials, production is

scheduled based on whether materials are available. Note:Note: When you optimize on both capacity and materials,

production is calculated to meet both restrictions. The availability of capacity and materials is considered, and

the production order ’s operations can't be scheduled to start until capacity and materials are available at the

same time and in the required quantities. Select this check box if materials should be considered limited during

scheduling. If the materials are limited, the material's coverage for that time will be considered. In other words,

scheduling considers the futures dates that are calculated for the items. Scheduling reserves raw materials and

explodes the current production. If scheduling occurs several times, only the first scheduling runs an explosion

and makes reservations. If you make changes in the production BOM or route, the next scheduling runs an

explosion. For the explosion, it's assumed that the materials are required on the same day. Because the

production isn't scheduled at the time of the master schedule explosion, the current date is the best estimate of

when the items will be available. The explosion then checks whether the items are available. If the items are

available, the production requirement can be fulfilled. If the items aren't available by the current date, a planned

order is generated, and an offset selection is made for the planned order. If automatic firming is set for the

planned order, the planned order is firmed automatically for purchase or production. The production status is

automatically changed to the status that is specified in the Requested production statusRequested production status  field in the

Coverage groupsCoverage groups  dialog box. If the check box is cleared, the materials are always considered available.

Therefore, scheduling doesn't consider whether the materials are available at the time of requirement.



Finite propertyFinite property

Keep production unitKeep production unit

Keep warehouse from resourceKeep warehouse from resource

References
Schedule referencesSchedule references

Synchronize referencesSynchronize references

Cancellation
Cancel queue timeCancel queue time

Cancel setupCancel setup

Cancel processCancel process

Cancel overlapCancel overlap

Cancel transportCancel transport

Set default

Select this check box if the job scheduling should include property requirements.

Select whether the scheduling engine should schedule only resources that are already specified on the

production unit.

Select whether the scheduling engine should schedule only resources that are associated with the input

warehouse that is specified on the resource.

When references depend on production orders, they are also known as subproductions. Subproductions can be

scheduled as part of the scheduling of a production order. Select this check box if the scheduling of

subproductions should be based on the scheduling of the main production. In relation to the main production,

overlying productions are scheduled forward, and underlying productions are scheduled backward. You can

view production order references can be viewed in the Reference levelReference level  field on the Production ordersProduction orders  page.

You can synchronize references with the production order. If this option is selected, the dates of the

subproductions are moved and aligned when changes are made to the production order ’s schedule. If a

production order has one or more subproductions, you might want to schedule the subproductions together

with the main production. In this case, the main production can't be started until the related subproductions

have been completed. Therefore, select this check box if the scheduling of subproductions should be based on

the start and end times of the selected production. You can select this check box only if the ScheduleSchedule

referencesreferences  check box is also selected.

Select this check box to exclude queue time from the scheduling.

Select this check box to exclude setup time from the scheduling.

Select this check box to exclude run time from the scheduling.

Select this check box to exclude overlap time from the scheduling.

Select this check box to exclude transit time from the scheduling.

You can save the current values as default values. There are two options:

Set as my default

Set as default for everyone



Additional resources
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Operations scheduling
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Tasks in the job scheduling process

Scheduling direction

Finite capacity

This article provides information about job scheduling, which is a more detailed form of scheduling than

operations scheduling. You can use job scheduling to schedule individual jobs or shop orders, and to control the

manufacturing environment.

You can use job scheduling to schedule individual jobs or shop orders, and to control the manufacturing

environment. Job scheduling breaks down each operation into its individual tasks or jobs. These jobs are then

assigned to the operations resources that will perform them. Job scheduling also lets you synchronize all jobs

that are referenced by the selected job. You can specify a start date and time or end date and time for the job,

and then run scheduling. The time that you specify can be the start time or the end time, depending on the

scheduling direction. This functionality is useful when, for example, a job can be run only on one machine at a

time, or when you want to optimize the job that is run for each resource.

The job scheduling process includes the following tasks:

Split operations into jobs.

Schedule jobs, based on the dates and times for the resources that are specified for the related operation.

Calculate start times and end times for each job. You can use finite capacity to make sure that there are no

overlapping times.

Determine which resources in the resource group to run the job on. This task requires that a resource group

be specified for an operation. Job scheduling selects the resources or resource groups based on the shortest

lead time, and also considers any previous reservations on the resources.

Explode operations into jobs when you run job scheduling. The jobs are scheduled by date and time,

according to the order that is specified by the production route. The setup of the operation determines the

jobs that are exploded during the scheduling process. The route group that is assigned to the operation

controls whether jobs are generated. A job is generated only if it has a specific duration. For example, a

transport time job is generated if a transport time was specified for the selected operation.

You can schedule jobs either forward or backward.

For wardFor ward – Use the forward scheduling direction to start the production as early as possible. This is also

known as the push method, because the production is being pushed forward through the production

process. The production is scheduled to start and end on the earliest possible dates.

BackwardBackward – Use the backward scheduling direction to start the production as late as possible. This is also

known as the pull method, because it's based on the date when the production must be completed. Backward

scheduling counts backward to the latest possible date that the production can be started without missing its

target deadline.

You can schedule jobs by using finite capacity. When you use finite capacity, the capacity that is scheduled can't

be larger than the capacity that is available for the resource. Available time is defined as the interval when the

resource is available and there are no other reservations on capacity. Scheduling that is based on finite capacity

makes sure that start times and end times for an operation on a specific date don't overlap. The resource
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capacity that is already reserved is considered, and overlaps between the start times and end times are also

considered. Finite capacity determines the amount of capacity that must be available for a resource in order to

achieve optimal use of that resource. This determination is balanced against a calculation of the shortest

possible lead time between operations.

Job scheduling that is based on finite materials makes sure that the required materials are available when the

operation starts. The coverage rules for items define these limits. Scheduling uses requirement explosion to

determine when the component items are available. If you schedule without setting finite materials, the system

assumes that all items are available when they are required.

Job scheduling that is based on special properties requires that properties be specified for the operations on the

production route. These properties must be fulfilled to reserve capacity.

Job scheduling schedules all productions that are referenced by the current production. If a production has one

or more subproductions, the subproductions should be scheduled at the same time as the main production,

because the main production can't be started until the related subproductions are completed.

The scheduling engine examines combinations of resources to identify those combinations that can satisfy

requirements. You can specify selection criteria by selecting one of the following values in the Pr imar yPrimar y

resource selectionresource selection field on the Scheduling parametersScheduling parameters  page:

DurationDuration – The scheduling engine selects the resource that has the shortest lead time. Note:Note: Scheduling by

duration can cause decreased performance when the same resource group contains many resources and

secondary operations are used. You can schedule a maximum of 32 resources per operation. If you exceed

this quantity, an Infolog message is displayed, and job scheduling doesn't find the best alternative resource.

Pr ior ityPr ior ity  – The scheduling engine selects the resource that has the highest priority if two or more resources

have identical capabilities and levels. The resource that has the lowest numeric value in this field has the

highest priority.

When job scheduling is run, the system plans the resources, based on the limitations that are defined in the

resource parameters. You can control the capacity of the resources by using calendar settings. The system

calculates loads for resources during the scheduling process. Note:Note: For productions that use the operations

scheduling function, you can run job scheduling after operations scheduling. If you aren't using operations

scheduling, you can run job scheduling alone.

Resources are assigned to jobs through job scheduling. You can establish maximum capacities for resources per

job order. For example, you can set up the system to schedule no more than 50 percent of total capacity for a

production order. This setup gives you more control over the scheduling of resources on the job scheduling

level. Therefore, it can help prevent issues if not enough capacity is available to perform simultaneous

productions.

Job scheduling considers the efficiency percentages that are specified for the resources. Efficiency percentages
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reduce or increase the time that is reserved for the resource. Therefore, lead time is also increased or decreased.

The following formula is used for the calculation: Scheduling time = Time × 100 ÷ Efficiency percentage In this

formula, Time includes both the run time and the setup time.
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This article describes the concept of consolidated batch orders.

A bulk item that is produced is considered a parent item, whereas a packed item is considered a child item. The

relation between the bulk item and the packed item is expressed in a bulk item conversion. This bulk item

conversion is defined on the bulk item itself.

Packed items can be packaged into containers of either a single size or multiple sizes that are considered one

unit. By consolidating the orders for a bulk item, you can see all the related batch orders in a single view that can

help you determine any remaining work that must be completed.

A consolidated batch order can contain any combination of the following orders:

A single bulk order and multiple packed orders

Multiple bulk orders and multiple packed orders

Multiple bulk orders and a single packed order

Only packed orders
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Create a batch order

View production formula and expected co-products

Estimate the batch order

Release the batch order

Schedule production jobs

This procedure takes you through the first part of the life cycle of a batch order.

From creation, cost estimation, and over production job scheduling to the actual start of a batch order.

The demo data company used to create this procedure is USMF.

The prerequisites for running the procedure with another dataset are a released product with an active formula

and route version.

1. Go to All production orders.

2. Click New batch order.

3. In the Item number field, enter or select a value.

4. Click Create.

5. Use the Quick Filter to filter on the Production field with a value of 'b'.

1. On the Action Pane, click Production order.

2. Click Formula.

3. Close the page.

4. Click Co-products.

5. Close the page.

1. Click Estimate.

2. Click OK.

3. On the Action Pane, click Manage costs.

4. Click View calculation details.

5. Close the page.

1. On the Action Pane, click Production order.

2. Click Release.

3. Click OK.

1. On the Action Pane, click Schedule.

2. Click Schedule jobs.

3. Select No in the Finite capacity field.

4. Select No in the Finite material field.

5. Click OK.
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6. On the Action Pane, click Production order.

7. Click All jobs.

8. Close the page.

1. Click Start.

2. Click the General tab.

3. Select No in the Post picking list now field.

4. Click OK.

5. On the Action Pane, click View.

6. Click Picking list.

7. In the list, click the link in the selected row.

8. Close the page.

9. Close the page.

10. Click Route card.

11. In the list, click the link in the selected row.

12. Close the page.

13. Close the page.
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Run master planning for USPI

View planned orders for the paint products

Sequence planned orders for paint

This procedure uses paint products as an example to show how to sequence planned orders according to the

priority of color and package size. The demo data company used to create this procedure is USPI. This procedure

is intended for the production planner.

1. Go to Master planning > Master planning > Run > Master planning.

2. In the Master plan field, click the drop-down button to open the lookup.

3. In the list, click the link in the selected row.

4. Click OK.

Select MasterPlan.

This starts Master Planning, including the sequence process. This process can take a few minutes.

1. Go to Master planning > Master planning > Planned orders.

2. Expand the Item details FactBox.

3. Expand the Schedule details FactBox.

4. In the Plan field, click the drop-down button to open the lookup.

5. In the list, find and select the desired record.

6. In the list, click the link in the selected row.

7. Use the Quick Filter to filter on the Item number field with a value of 'P300'.

Select MasterPlan.

Unlock to scroll to the right to see the order date and delivery date. Notice that these items have an

order date of Today and the delivery dates for the planned orders are not sequenced after the priority

of color and package size, as shown in the product name. You can hover over an item number to see

the product name and priority.

1. Close the page.

2. Go to Master planning > Master planning > Sequenced planned orders.

3. Expand the Item details FactBox.

4. Expand the Schedule details FactBox.

5. Mark all rows.

6. Click Accept.

Note: Here you see that the Start date/time for the planned orders are sequenced according to color

and package size within a bucket period of 28 days. These periods are defined by a number in the field

Campaign. The sequenced planned order form acts like the typical planned order form, and the

production planner can firm the planned orders here.

This will update the planned orders with the selected sequence action of either Postpone or Advance.
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1. Close the page.

2. Go to Master planning > Master planning > Planned orders.

3. Expand the Item details FactBox.

4. Expand the Schedule details FactBox.

5. In the Plan field, click the drop-down button to open the lookup.

6. In the list, find and select the desired record.

7. In the list, click the link in the selected row.

8. Use the Quick Filter to filter on the Item number field with a value of 'P300'.

Select MasterPlan.

Notice that the orders now are sequenced according to the priority of color and size and the planned

orders start at the earliest order date and delivery date. Validate the Order date column or the Start

date in the Schedule details FactBbox.
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Substituting material by date

Substituting material by planning

Substituting material during production

This topic describes how to substitute materials during the production process.

There are three methods for substituting materials during the production process:

By date, when one material is substituted for another after a specific date

During master planning, when a material in a formula is substituted with a different material, because it's out

of stock

During production, when a material is unexpectedly out of stock and is substituted with a different material

Consider following scenario: A machine that a company is manufacturing contains a component that will expire

from the vendor's catalog in two months. From the expiration date onward, the vendor will offer a new

component that can be substituted for the old component. From and to validity dates can be set up on bill of

materials (BOM) lines. For this example, you set up the old component to expire by entering the expiration date

in the To-dateTo-date field. Then, on the BOM, you set up the new, replacement component so that it's valid from the

day after the old component expires. To do this, enter the start date in the From-dateFrom-date field.

You can substitute materials during planning only when you're using formulas, not when you're using a BOM.

Consider following scenario: A food manufacturing company is making a sauce from a formula that has 20

ingredients. One ingredient in the formula can be substituted by one of two other ingredients. However, because

these two ingredients are more expensive than the preferred ingredient, substitution is used only if the

preferred ingredient is out of stock. The material that can be substituted is called A, whereas the two materials

that can replace it are called B and C. Material substitution by planning is controlled by the Plan groupPlan group and

Prior ityPr ior ity  fields on the formula lines. For this example, you create formula lines for the three materials, and

associate the formula lines with the same plan group. In the setup, the formula line for material A has the

highest priority (lowest number), the formula line for material C has the lowest priority, and the formula line for

material B has a priority that is between the priority of the other two lines. If you have demand for the finished

item, master planning first determines whether the demand for material A can be covered. If the demand can't

be covered, master planning looks at materials B and C, in order of priority. If material B is on hand, it will be

used after a planned batch order is firmed for the formula. If none of the materials are on hand, master planning

creates a planned order for material A. Note:Note: When you set up formula lines in a plan group, you should specify

a quantity only on the material that has the highest priority. This quantity will be used to calculate the demand of

all materials in the plan, even the materials that have lower priority. You can't specify different quantities on

lower-priority items in the plan group.

Consider the following scenario: A piece of metal plate is required for a welding operation. During the operation,

a warehouse worker informs the machine operator that the plate is out of stock. However, it's decided that the

plate can be substituted with a plate that is slightly thicker. That way, the operation can be finalized. Material can

be added to the BOM for an open production order. If the production order has a status of Star tedStar ted, users are

asked to re-estimate the order when they add a new item to the production BOM. After the material is added, a

new picking list can be created for the new item. You don't have to add the new material to the production BOM.

Instead, you can add it directly to the production picking list. Then, when the picking list is posted, the system
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adds the material to the production BOM.
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Manufacturing execution and registration terminology
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Manufacturing execution A function that is used to register time, material
consumption, costs on production jobs, projects, and indirect
activities. Registration is done in a manufacturing execution
registration client.

Job list On the Job registrationJob registration page, workers are shown the list
of jobs that they must perform on a specific resource, such
as a machine. A worker can register time and item
consumption on each job or task in the job list.

Job bundling If a worker starts more than one job at the same time on
the Job registrationJob registration page, this is called job bundling. The
time that is spent on bundled jobs can be allocated to the
individual jobs in various ways by using allocation keys.

Pilot/assistant registrations A worker can register as an assistant to a resource, and can
create a small team where several workers work on the same
production jobs. Resources that workers are connected to as
assistants are called pilots. Only the pilot resource must
make registrations. All assistants automatically get the same
registrations. For example, if a machine acts as the pilot,
workers who have registered as assistants to that machine
can make registrations on the Job registrationJob registration page, and
both the machine and the workers who are connected as
assistants will receive the same registrations.

Indirect activity An activity or task that isn't directly related to a production
job or a project, such as a department meeting, a cleaning
job, or a maintenance job on the shop floor. Workers can
make registrations on indirect activities, in the same way
that they can register on production jobs and projects.

Registrations in manufacturing execution

This topic describes key concepts and terms that you need to understand to configure and use manufacturing

execution.

Manufacturing execution is intended to be used primarily by manufacturing companies. Workers can register

time and item consumption on production jobs by using the Job registrationJob registration page. All registrations are

approved and are later transferred to the relevant modules. Continuous approval and transfer of registrations

lets managers easily track actual costs on production orders.

The following table contains terms that pertain to manufacturing execution and related registration tasks.

Workers can make various types of registrations in manufacturing execution for work that is performed on

production jobs. Depending on the system setup, workers might also be able to make registrations on project

activities and nonproductive tasks, such as breaks, absences, and indirect activities. Here are the registration
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types:

Clock-in/clock-outClock-in/clock-out (available with time and attendance) – Workers clock in when they arrive at work and

clock out when they leave to go home.

Register on production jobsRegister on production jobs  – Workers can make registrations, such as starting a job and reporting

feedback for a job, on the production jobs that appear in their job list. Workers can start several jobs at the

same time. This is referred to as job bundling.

Register on inventor yRegister on inventor y  – Workers can make registrations on materials that are used on the shop floor, but

that aren't directly related to production jobs. Examples include grease, lubricants, or other materials that are

used to keep machinery running. Registration is performed in an inventory journal.

Register on projectsRegister on projects  (available with time and attendance) – Workers can make registrations, such as

starting and finishing work on the projects or project activities that appear in their job list.

Register project fees and project itemsRegister project fees and project items (available with time and attendance) – Workers can register fees

(expenses) that are associated with a project in a project fee journal, such as mileage and bridge toll. Workers

can also register item consumption on projects. This is done in a project item journal.

Register as assistant to another workerRegister as assistant to another worker  – If two or more workers will work together on a production job

or a project, a worker can register as an assistant to a machine, or to another worker, who will then act as the

pilot. The pilot can select another worker as the pilot, as required.

Register absenceRegister absence (available with time and attendance) – Workers can register time on various absence

codes that are set up. Absence can be indicated if a worker arrives late, requires absence during the work day,

or leaves earlier than expected according to the standard work time profile.

Register breaksRegister breaks  (available with time and attendance) – During the work day, workers can register that they

are leaving their workstation to take a break. Several break types can be set up. When a worker returns and

logs on again, the system registers that the worker is back, and the break registration stops.

Register indirect activitiesRegister indirect activities  (available with time and attendance) – Indirect activities are nonproductive

activities that workers might engage in during a workday, such as a department meeting, a team meeting, or

a maintenance job that is performed on the shop floor. Workers can make registrations on the indirect

activities that are set up.

Register over timeRegister over time (available with time and attendance) – Workers who have been asked to work longer

hours can select whether the extra hours should be registered as flextime or overtime.
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This article provides information about production feedback, which gives workers feedback about production

jobs. The article includes information about the various ways that production feedback can be updated.

Production feedback gives workers feedback about production jobs. It records time and material consumption

on production orders, operation quantities and status, and errors that cause a job or operation to fail. Production

feedback can be updated in journals that are related to production orders. The Production job cardProduction job card and

Production route cardProduction route card journals are used to report time and quantities per job or operation. For reporting

about the last job or operation, quantities on the finished product can be reported as finished. Production

feedback can also be updated on the Job card terminalJob card terminal  and Job card deviceJob card device pages. These pages enable

production feedback to be updated on the shop floor and are part of the manufacturing execution functionality

in the Production controlProduction control  module. The Job card terminalJob card terminal  page has a configurable user interface that shows

a list of the released jobs in a prioritized order for a selected work area. It also offers advanced options such as

job bundling and team work. The Job card deviceJob card device page has a touch-optimized user interface. Production

feedback on both pages is updated from the production journals.
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Registrations

N OT EN OT E

If you run Time and attendance together with Manufacturing execution, all registrations on projects, project activities, indirect
activities, absence codes, and overtime and flex time will be recorded and are used to calculate payroll in both modules.

Time registrations workers
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A worker can be automatically assigned the time registrations that are made on a particular machine on the shop floor, if the
worker chooses to work as an assistant to the machine when he or she starts the production job.

Time registration workers can enter different types of time registrations, for example, clock in, clock out, register

indirect activities, and absence registration. This topic describes registrations, their calculation, approval, and the

use of workflow to add structure and automated approval to the process of approving timesheets.

In companies that use Time and attendance, workers must register the time that they spend at work, as well as

their attendance. Some companies may only require workers to register clocking-in and clocking-out times. In

other companies, workers may also be required to register time consumption on the actual activities they

perform as well as the breaks they take. The intended users of Time and attendance are:

Workers, who are required to register time and attendance at regular intervals, for example daily, weekly or

bi-weekly.

Supervisors, managers, and payroll officers who calculate, approve, and transfer worker registrations for

further processing.

To be able to register time and absence, workers must be set up as time registration workers in the company

they are employed in.

After setup, the workers can enter different types of registrations.

Clocking in- and out when arriving or leaving work.

Time and item consumption on production jobs.

Time used on a machine on the shop floor, if the machine has been defined as a resource.

Time registrations on projects and project activities.

Registering project fees and item consumption via the respective project fee journals and project item

journals.

Planned absence.

Absence when arriving late to work or leaving earlier than planned.

Work breaks, either manually registered or automatically calculated by the system.

Indirect activities, which are non-productive activities a worker might engage in during a workday. Examples

of these activities include meetings or cleaning their workspace.

Overtime, which can be registered either as extra hours, flextime, or overtime.
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If overtime has been calculated for specific workers, the overtime can be allocated to specific jobs during the day. This is
relevant if job cost is calculated based on worker pay.

Approving registrations using workflow

If a worker forgets to clock-out at the end of their workday, the missing registration can be added by running a

batch job. The system will compare the clock-in time and the clock-out time according to the associated profile

of the worker, and automatically insert the missing clock-out registration to match the profile’s end time. Both

the clock-in and clock-out registrations are vital for the subsequent calculation and approval of time

registrations before they can be transferred to payroll.

When a registration worker is assigned a calculation group that typically relates to a specific team, shift, or work

group. The team manager or supervisor typically validates the registrations made by the workers, and is

therefore also the responsible person to run the calculation for the respective calculation groups on a daily

basis. As part of the calculation process the team manager or supervisor is able to:

Correct erroneous registrations. For example, change switch codes and adjust feedback on production jobs.

Add missing registrations. For example, create clock-out registrations and create absence transactions.

Delete incorrect registrations.

Because the registered time must match the worker ’s time profile prior to calculating the registrations, you must

override the work time profile for any worker who has an exception to his standard work time profile. In the

case, where the worker profile is day shift, and the worker has agreed to work a night shift with no overtime pay,

the team manager or supervisor must override the default worker profile in order to calculate the working time

at the standard night rate and not as overtime. The calculation will also display an error if an absence

registration is missing. It must be added before the calculation can be completed.

Just as you assign a calculation group to a time registration worker, you must assign an approval group as well.

Typically the group will be specific to a team, shift, or work group. You must approve the time registrations that

were calculated correctly – this means doing a calculation without errors – before pay items can be generated

that afterward can be transferred to a payroll system. The payroll administrator will typically do the approval of

registrations, and prior to the approval he is able to:

Override pay agreements for individual workers.

Add manual premiums.

Enter additional information about absence registrations.

You can set up a workflow approval process that automatically approves registrations which comply with

workflow rules, leaving only deviations to be handled manually. If workflow approval is activated, the team

manager or supervisor submits the calculated registrations for approval. The workflow process will generate the

appropriate approvals and tasks, and then assign them to the right users and roles as identified in the workflow.

There are two workflow approvals for time and attendance.
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Time and attendance days total The workflow validates registrations
against, for example, the expected
number of work hours for the day.

Time and attendance journal
registration.

The workflow validates each
registration type for the date of the
registration.

Time and attendance • Clock-in •
Clock-out • Absence • Break • Switch
code • Project • Project activity •
Indirect activity Production jobs •
Queue before • Setup • Process •
Overlap • Transport • Queue after •
Start assistance • Stop assistance

Transferring approved registrations

Reversing transferred registrations
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The external file can be imported into a payroll system.

Registrations in electronic timecards

NOTENOTE

After approval of the registrations you can transfer them to a periodic payroll job. A transferred registration is

posted to an activity or job that it relates to, for example, a production order or a project. Payroll transactions are

generated for each worker based on the registrations.

The task of reversing transactions – rolling them back – can be done until the time when the payroll period’s pay

transfer is run. This means that payroll data has been transferred to an external file. When reversed, all

registrations are withdrawn, and any transactions posted on production orders or projects are offset and

neutralized.

Workers with job tasks that do not require immediate feedback, as is the case with production jobs, but who

work on project activities, can benefit from using the electronic timecard. Electronic timecards offer the flexibility

to enter registrations any time and in the best way for your business schedule – daily, weekly, or when a worker

is in the office again after being away. To use electronic timecards or these workers, you must specify, Use

timecard, in the worker details. Electronic timecards enable the worker to register :

Date

Registration type

Job reference, such as project, indirect activity, or production order

Job identification

Time consumption

Project fees

Project items
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Example scenario

JO BJO B P RO DUC T IO N  T IM EP RO DUC T IO N  T IM E

Job 1 1 hour

Job 2 3 hours

Job 3 4 hours

Total 8 hours

JO BJO B STA RT  T IM ESTA RT  T IM E EN D T IM EEN D T IM E B UN DL E T IM EB UN DL E T IM E

Job 1 09:00 11:00 2 hours

Job 2 10:00 13:00 3 hours

Job 3 10:00 15:00 5 hours

Bundle 09:00 15:00 6 hours

In Manufacturing execution, you can bundle jobs. You can then start multiple jobs at the same time on the Job

list page.

If you bundle jobs, you must define how the total registered time for all the jobs should be allocated to each job.

You define the allocation by selecting one of the following options in the Bundle typeBundle type field on the AllocationAllocation

keyskeys  page:

EstimationEstimation – Time is divided among the jobs, based on the estimated time for the jobs.

JobsJobs  – Time is divided according to total jobs that are bundled and how much time was spent finishing all

the jobs.

Net timeNet time – Time is divided equally among the jobs that are in the bundle at any time.

Real timeReal time – Actual job time is allocated. The cost can be calculated based on the actual payroll cost. Note:Note:

The Real timeReal time allocation key is available only if your company uses the payroll functionality in Time and

attendance.

The following examples show the results of the various allocation keys.

Three jobs in your job queue must be completed. You start the first job, and then, while that job is in progress,

you start the second and third jobs. Therefore, there is a bundle of three jobs. The following table shows the

estimated production time for each job.

The following table shows the actual work hours that are spent on each job.

The following sections describe the results of the calculated time for each allocation key.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/allocate-time-jobs-job-bundle.md


Estimation allocation key

JO BJO B F O RM UL AF O RM UL A A L LO C AT ED T IM EA L LO C AT ED T IM E

Job 1 6 × (1 ÷ 8) hours 0.75 hour

Job 2 6 × (3 ÷ 8) hours 2.25 hours

Job 3 6 × (4 ÷ 8) hours 3.00 hours

Jobs allocation key

JO BJO B F O RM UL AF O RM UL A A L LO C AT ED T IM EA L LO C AT ED T IM E

Job 1 6 ÷ 3 2 hours

Job 2 6 ÷ 3 2 hours

Job 3 6 ÷ 3 2 hours

Net time allocation key

09: 00–10: 00 ( 109: 00–10: 00 ( 1
H O UR)H O UR)

10: 00–11: 00 ( 110: 00–11: 00 ( 1
H O UR)H O UR)

11: 00–13: 00 ( 211: 00–13: 00 ( 2
H O URS)H O URS)

13: 00–15: 00 ( 213: 00–15: 00 ( 2
H O URS)H O URS)

A L LO C AT EDA L LO C AT ED
T IM ET IM E

Number of jobs
in the bundle

1 3 2 1 Not applicable

Job 1 1 ÷ 1 = 1 hour 1 ÷ 3 = 0.33
hour

Not applicable Not applicable 1.33 hours

Job 2 Not applicable 1 ÷ 3 = 0.33
hour

2 ÷ 2 = 1 hour Not applicable 1.33 hours

Job 3 Not applicable 1 ÷ 3 = 0.33
hour

2 ÷ 2 = 1 hour 2 ÷ 1 = 2 hours 3.33 hours

Real time allocation key

The following table illustrates the formula for calculating allocated time. Here is the formula: Time per job =

Total bundle time × (Estimated job time ÷ Total estimated time)

The following table illustrates the formula for calculating allocated time. Here is the formula: Time per job =

Total bundle time ÷ Number of jobs

The following table illustrates the formula for calculating allocated time. Here is the formula: Calculated time per

reporting = Bundle time ÷ Number of jobs

If you want production costs to be calculated based on real costs, you must clear the Cost categor yCost categor y  option on

the Production order defaultsProduction order defaults  page. The following table illustrates the formula for calculating allocated time.

Here is the formula: Actual time per job = Actual time in bundle



JO BJO B A C T UA L  T IM EA C T UA L  T IM E

Job 1 2 hours

Job 2 3 hours

Job 3 5 hours

JO BJO B

C A L C UL AT IO N  O FC A L C UL AT IO N  O F
C O RREC T ED C O STC O RREC T ED C O ST
P ER H O URP ER H O UR

C O RREC T ED C O STC O RREC T ED C O ST
P ER H O URP ER H O UR A L LO C AT ED T IM EA L LO C AT ED T IM E TOTA L  C O ST  O F  JO BTOTA L  C O ST  O F  JO B

Job 1 (1.33 ÷ 2) × USD
12.00

USD 8.00 2 hours USD 16.00

Job 2 (1.33 ÷ 3) × USD
12.00

USD 5.33 3 hours USD 16.00

Job 3 (3.33 ÷ 5) × USD
12.00

USD 8.00 5 hours USD 40.00

NOTENOTE

Consider the three jobs that are performed by a worker who has an hourly wage of USD 12.00. No overtime

bonus or premium was earned in the time that was spent on the jobs. The worker worked on the three bundled

jobs for a total of six hours. Therefore, the salary cost is 6 × USD 12.00 = USD 72.00. When you use real-time

allocation, the cost per hour is recalculated by using the factor from the Net time formula. The actual time that

was spent on each job is then transferred together with the corrected cost price per hour. In the example, six

hours are spent, although 10 hours were allocated. The following table illustrates the formula for calculating

cost. Here is the formula: Cost per hour = (Total bundle time per job (Net time) ÷ Actual time per job) ×

Standard cost price per hour

The corrected cost per hour and the job time are posted in a production journal. Note:Note: If you select the CostCost

categor ycategor y  option on the GeneralGeneral  tab on the Production order defaultsProduction order defaults  page, the actual time for each job is

transferred to a production journal, where the cost is applied to the cost category of the specific job.
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Variable and constant consumption

Calculating consumption from a formula

Rounding up and multiples

QuantityQuantity

MeasurementMeasurement

This article provides information about various options that are related to the calculation of material

consumption.

The following options that are related to the calculation of material consumption are available on the SetupSetup and

Step consumptionStep consumption tabs on the L ine detailsL ine details  FastTab of the Bill of mater ialsBill of mater ials  page.

In the Consumption isConsumption is  field, you can select whether consumption should be calculated as a constant quantity

or a variable quantity. Select ConstantConstant if a fixed quantity or volume is required for the production, regardless of

the quantity that is produced. Select Var iableVariable, which is the default setting, if the required amount of material in

the finished goods is proportional to the number of finished goods that are produced.

In the FormulaFormula field, you can set up various formulas for calculating material consumption. If you use the

default value, StandardStandard, the consumption isn't calculated from a formula. The following formulas work together

with the HeightHeight, WidthWidth, DepthDepth, DensityDensity , and ConstantConstant fields:

Height * Constant

Height * Width * Constant

Height * Width * Depth * Constant

(Height * Width * Depth / Density) * Constant

Together, the Rounding upRounding up and MultiplesMultiples  fields let you round up the material consumption value. For

example, you can round up the value according to the handling unit in which the raw material is picked for

production. The following options are available in the Rounding upRounding up field: QuantityQuantity , MeasurementMeasurement, and

ConsumptionConsumption.

If you select QuantityQuantity  as the rounding-up mechanism, the quantity must be a multiple of the specified quantity.

For example, if whole numbers are required, select 11  in the MultiplesMultiples  field. Numbers are then rounded up to a

quantity that is divisible by 1.

Typically, you select MeasurementMeasurement as the rounding-up mechanism when the raw material comes in specific

dimensions. For example, a piece of 2-meter metal tube is required for a finished good, and the metal tube is

stored in 4.5-meter lengths. In this case, the MeasurementMeasurement rounding-up mechanism can be used to calculate

how many metal tubes are required to produce a specific number of pieces of the finished good. For this

example, the FormulaFormula field is set to Height * ConstantHeight * Constant. The HeightHeight field is set to 22  to indicate the length of

the tube that is required for the finished good. The MultipleMultiple field is set to 4.54.5  to indicate that the tube is picked

in lengths of 4.5 meters. Here is the calculation:

1. Number of multiples that are required for 10 pieces of the finished good: 10 ÷ 2 = 5 pieces

2. Total consumption: 4.5 × 5 = 22.5 meters of metal tube

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/consumption.md


ConsumptionConsumption

Step consumption

F RO M  SERIESF RO M  SERIES Q UA N T IT YQ UA N T IT Y

0.00 10.0000

100.00 20.0000

200.00 40.0000

NOTENOTE

It's assumed that 0.5 meter of tube is scrapped for every five pieces of tube that are consumed.

Typically, you select ConsumptionConsumption as the rounding-up mechanism when raw material must be picked in whole

quantities of a specific handling unit of the product. For example, 2 quarts of paint are used to produce one

piece of a finished good, and the paint is picked in 25-quart cans. In this case, the ConsumptionConsumption rounding-up

mechanism can be used to round up consumption to whole numbers of 25-quart cans. Here is the calculation

for the amount of paint that is required if 180 pieces of the finished good must be produced:

1. Paint that is required, excluding scrap: 180 × 2 = 360 quarts

2. Number of cans: 360 ÷ 25 = 14.4, which is rounded up to 15

3. Paint that is required, including scrap: 15 × 25 = 375 quarts

Step consumption is used to calculate constant consumption in quantity intervals. If you select StepStep

consumptionconsumption in the FormulaFormula field on the SetupSetup tab, you can add information about the steps on the StepStep

consumptionconsumption tab. The fixed consumed quantity can be set up in intervals of the produced quantity. For

example, step consumption is set up as shown in the following table.

The bill of materials (BOM) quantity is 1, and the production quantity is 110. The formula for the consumption is

From series (Quantity) = Consumption. Because the production quantity is 110, it falls into the "From 100

series." Therefore, the quantity is 20.
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Material consumption

Time consumption

Reporting finished goods and error quantities

Ending the production order

Controlling the level of ledger posting

This article provides information about different types of postings in the production process.

Production posting activities follow production processes that are described in the sections below.

Materials are registered as consumed during production when the production picking list journal is posted. This

process generates issue transactions that deduct the on-hand inventory. In the production parameters, you can

specify whether the value of raw materials that are in progress (work in process [WIP]) should be posted in the

ledger. The value of raw materials that are in progress (WIP) is then posted to a dedicated Picking list account

and a dedicated Picking list offset account.

The time that workers spend on production jobs is recorded in the Route card journal or the Job card journal.

When these journals are posted, ledger posting to a dedicated account for resources that are in progress (WIP)

is processed. This posting represents the value of the time that is spent on the production order. After the

production order is registered as ended, the WIP accounts are settled.

When a production order is reported as finished, the quantity of the finished goods that have been completed is

updated in Inventory management through the Report as finished journal. If you're using WIP accounting, which

can be set up in the production parameters, a ledger journal is made to reduce the WIP accounts and increase

the inventory of the finished goods. The journal uses the standard cost that is defined for the product.

Before a production order is ended, actual costs are calculated for the quantity that was produced. All estimated

costs of material, labor, and overhead are reversed and replaced with actual costs. The overall cost of the

finished item is debited from the inventory Receipt account and credited to the inventory Issues account. If you

select the End jobEnd job check box when you run the cost calculation, the status of the production order is changed to

EndedEnded. This status prevents any additional costs from being unintentionally posted to a completed production

order. You can specify that the value of error quantities that are reported during reporting as finished should be

allocated to the good quantities that are reported as finished. Alternatively, you can specify that the value of

error quantities should be posted to a dedicated scrap account.

In the Production control parametersProduction control parameters , you can use the Ledger postingLedger posting field to set the level of ledger

posting for production processes. The following values are available:

Item and resourceItem and resource – Use the ledger accounts that are set up on the item groups for raw materials and

finished goods. WIP for time consumption is taken from resource or resource group from the route

operations.

Item and categor yItem and categor y  – Use the ledger accounts that are set up on the item groups for raw materials and

finished goods. WIP for time consumption is taken from the cost categories that are associated with the route

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/cost-management/production-posting.md


NOTENOTE

operations.

Production groupsProduction groups  – Use the ledger accounts that are set up on the production groups for both material

and time consumption. The production groups are associated with the released products and copied to the

production orders when those orders are created. The posting on the production orders will then follow the

production groups that are associated with the production order.

Note:Note: If the standard method for calculating the cost of the finished item was used, the final transactions reflect

this fact. If actual costs and the costs that are calculated by using the standard method differ, the difference is

posted to the account that shows profit or loss.
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When I use the job card device to report a partial quantity on the last
job in a production order, all the previous jobs on that order that have
a status of In progress are automatically ended.

When I attempt a stock closing, I receive the following warning
message: "No execution of Backflush costing calculation with a date
%1 matching period end has been registered."

NOTENOTE

This topic describes how to fix issues that you might encounter while you work with process manufacturing.

This behavior is by design. On the Production order defaultsProduction order defaults  page, on the Repor t as finishedRepor t as finished tab, there is

an option that is named End-mark routeEnd-mark route. If this topic is set to Yes, a route card journal is posted when a worker

uses the job card device or job card terminal to report the last operation. This journal marks all the operations as

completed and ends all the production jobs. When the End-mark routeEnd-mark route option is set to Yes, the system doesn't

consider the job status that the worker selected when they reported the last operation. The system also doesn't

consider whether the worker is reporting a full or partial quantity.

In releases before release 10.0.13, if you aren't using the lean production costing flow, you receive the following

erroneous warning message during inventory closing:

You are about to execute an Inventory close with a date %1. No execution of Backflush costing calculation

with a date %1 matching period end has been registered. Please remember to execute a Backflush costing

calculation with a date of %1 matching period end. The valuation of inventories, cost of goods sold and

variances might not be correct in Subledger or General ledger until this has been executed.

This issue has been fixed in release 10.0.13 and later. For more information, see KB 4582468.
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Marketing

RelationshipsRelationships

You can use Sales and marketing to obtain, store, and use various types of data in the sales flow. This data

includes the original sales initiative, future follow-up action, and additional sales.

You use marketing campaigns and activities to find and build relationships with potential customers, so that

initial interactions can develop into sales relationships. The following process flow shows the business process

for marketing. 

In sales and marketing, the initial interactions that you have with potential customers can occur in various

situations. For example, you might find a prospective customer while you're attending a trade show, or you

might have a possible lead with a customer after your organization runs a mass mailing campaign. It's very

important that you understand the flow of a party’s entity before that party becomes a customer. The following

graphic shows the flow of entity relationships as a potential customer becomes an actual customer. 

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/overview-sales-marketing.md
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CampaignsCampaigns

Sales

A campaign targets the contacts for prospects, leads, opportunities, and customers that have been selected to

participate in the campaign. In Supply Chain Management, you can create several types of campaigns, such as

telemarketing, mailing, and email campaigns, to maximize your customer potential. As your campaign

progresses and you receive positive responses, you can begin the sales process with those recipients who have

responded positively to the campaign.

You use the sales functionality to create quotations, up-sell and cross-sell to new and existing customers, create

sales orders, and create sales invoices for customers. The following process flow shows the business process for

sales. 

file:///T:/eiye/ac1a/dynamics365/supply-chain/sales-marketing/media/salesandmarketing01.jpg


Sales quotationsSales quotations

Up-sell/cross-sellUp-sell/cross-sell

Sales ordersSales orders

SA L ES O RDER T Y P ESA L ES O RDER T Y P E DESC RIP T IO NDESC RIP T IO N

Journal Use this type as a draft for a sales order. This type has no
effect on the stock quantities and doesn't generate item
transactions.

You create sales quotations to present customers an offer of the goods or services that you will be providing. A

customer might request a quotation, or you might create a quotation in response to a request from a potential

or existing customer. When the customer approves the sales quotation, you can convert it to a sales order.

Up-selling and cross-selling are techniques for selling products when an order is entered for a customer. In up-

selling, another product is suggested instead of the current product. In cross-selling, a product is suggested in

addition to the current product. When you set up product lists, you can create specific rules to indicate when a

product should be suggested as a cross-sell or up-sell product.

When you create a new sales order, you must select the type of sales order to create. You have five options.

Note:Note: After you create a sales order, any order type can be changed, except the Items requirementsItems requirements  type if the

sales order has a status of DeliveredDelivered.

file:///T:/eiye/ac1a/dynamics365/supply-chain/sales-marketing/media/sales01.jpg


Subscription Use this type for recurring orders. When the order is
invoiced, the order status is automatically set to an open
order. The delivered quantity that was invoiced and the
remaining deliveries are updated. You can’t use this sales
order type if you're using the Warehouse management
functionality.

Sales order Use this type when a customer has placed or confirmed an
order.

Returned order Use this type when a customer returns an item. A return-
item number (RMA number) is assigned automatically.

Item requirements This type is created automatically when you make an item
sale through a project.

SA L ES O RDER T Y P ESA L ES O RDER T Y P E DESC RIP T IO NDESC RIP T IO N

Sales agreementsSales agreements

BackordersBackorders

Viewing backorders by itemViewing backorders by item

Viewing backorders by customerViewing backorders by customer

Viewing backorders by vendorViewing backorders by vendor

InvoicesInvoices

A sales agreement is a contract that commits the customer to buy a product in a specific quantity or for a

specific amount over time, in exchange for special prices and discounts. The prices and discounts of the sales

agreement overrule any prices and discounts that are stated in any trade agreements that exist. A sales

agreement is valid for a defined period. The requested ship date that is specified for a sale on the Sales orderSales order

page should be in the valid period. By default, a sales agreement is on hold. You can order from a sales

agreement only when it's set to EffectiveEffective.

When you enter and validate orders, you might have to manage backorders and exceptions before the sale can

be completed. Backorders are either purchase orders that haven't yet been delivered from a vendor or sales

orders that haven't yet been delivered to a customer. It's important that you follow up on backorders. For

example, if products are delayed from a vendor, you might have to change the date of delivery to a customer

and then inform the customer of the delay. You can view backorders by item, customer, or vendor.

When you view backorders by item, you can follow up on the expected future flow of transactions for a specific

item. For example, you can check the following information:

The number of sales orders that are placed for an item

Whether deliveries of the item from vendors are still missing

Whether more items should be ordered, so that you can deliver all sales orders in a timely manner

By doing this check, you can respond to requests from customers about the timing of the item delivery. In

addition, you can prioritize the sales backorders and split the items that are on-hand between the orders.

When you view back orders by customer, you can view the status of the customer’s remaining orders. This check

is useful when you must respond to customers who are waiting for items that have been delayed.

When you view backorders by vendor, you can follow up on missing deliveries and expected dates of delivery.

This check also helps you prioritize the backorders when products arrive from vendors and the sales orders

must be picked for delivery.

You can create three types of invoices during the sales process:



Customer invoiceCustomer invoice

Free text invoiceFree text invoice

Pro forma invoicePro forma invoice

Additional resourcesAdditional resources
BlogsBlogs

NOTENOTE

Customer invoice

Free text invoice

Pro forma invoice

A customer invoice is a bill that an organization gives to a customer in connection with a sale. You create this

kind of customer invoice based on a sales order that includes a header and one or more lines for items or

services. The customer invoice completes the sales order, packing slip, and sales invoice cycle.

You can post and print a single customer invoice, based on either a sales order or the packing slip and date. You

can also post and print multiple customer invoices together, based on the packing slips and dates. When you

post a single customer invoice by using the sales order, the Invoiced remainderInvoiced remainder  quantity for each item is

updated with the total of the invoiced quantities from the selected sales order.

If both the Invoiced remainderInvoiced remainder  and Deliver remainderDeliver remainder  quantities for all items on the sales order are 0 (zero),

the status of the sales order is changed to InvoicedInvoiced. If the quantity of either field isn't 0, the status of the sales

order isn't changed, and you can enter additional invoices. If you plan to post and print one or more customer

invoices based on the packing slips, you must have already posted at least one packing slip for each sales order.

The customer invoice is based on the packing slips and reflects the quantities that are listed.

You can create a customer invoice that is based on the packing slip line items that have been shipped to date,

even if all the items for a particular sales order haven't yet been shipped. You might do this if, for example, your

legal entity issues one invoice per customer per month to cover all the deliveries that you ship during that

month. Each packing slip represents a partial or complete delivery of the items on the sales order.

When you post the invoice, the Invoice remainderInvoice remainder  quantity for each item is updated with the total of the

delivered quantities from the selected packing slips. If the Invoice remainderInvoice remainder  and Deliver remainderDeliver remainder

quantities for all items on the sales order are 0 (zero), the status of the sales order is changed to InvoicedInvoiced. If the

quantity isn't 0, the status of the sales order isn't changed, and you can enter additional invoices. Inventory

transactions are updated with the invoice number, and the status on the sales order line is changed to InvoicedInvoiced.

A free text invoice is an invoice that isn't related to a sales order. It contains order lines that include ledger

accounts, free-text descriptions, and a sales amount. You can’t enter an item number on this kind of invoice, and

you must enter the appropriate sales tax information. A main account for the sale is indicated on each invoice

line. The customer balance is posted to the summary account from the posting profile that is used for the free

text invoice.

A pro forma invoice is an invoice that is prepared as an estimate of the actual invoice amount before the invoice

is posted. You can print a pro forma invoice for either a customer invoice or a free text invoice.

You can find an overview of a sales process in the post How sales work in Dynamics 365 for Finance and

Operations.
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NOTENOTE

ATP calculations

This topic provides information about order promising. Order promising helps you reliably promise delivery

dates to your customers and gives you flexibility so that you can meet those dates.

Order promising calculates the earliest ship and receipt dates, and is based on the delivery date control method

and transport days. You can select among four delivery date control methods:

Sales lead timeSales lead time – Sales lead time is the time between creation of the sales order and shipment of the items.

The delivery date calculation is based on a default number of days, and does not consider stock availability,

known demand, or planned supply.

ATP (available-to-promise)ATP (available-to-promise)  – ATP is the quantity of an item that is available and can be promised to a

customer on a specific date. The ATP calculation includes uncommitted inventory, lead times, planned

receipts, and issues.

ATP + Issue marginATP + Issue margin – The shipping date is equal to the ATP date plus the issue margin for the item. The

issue margin is the time that is required to prepare the items for shipment.

CTP (capable-to-promise)CTP (capable-to-promise)  – Availability is calculated through explosion.

When a sales order is updated, the order promising information is only updated if the existing order promising date can't

be fulfilled, as illustrated in the following examples:

Example 1Example 1 : The current order promising date is July 20, but due to increased quantity, you won't be able to deliver

until July 25. Because the current date can no longer be met, order promising is triggered.

Example 2Example 2 : The current order promising date is July 20, but due to decreased quantity, it is now possible to deliver on

July 15. However, because the current date can still be fulfilled, order promising is not triggered, and July 20 remains

the order promising date.

The ATP quantity is calculated by using the “cumulative ATP with look-ahead” method. The main advantage of

this ATP calculation method is that it can handle cases where the sum of issues among receipts is more than the

latest receipt (for example, when a quantity from an earlier receipt must be used to meet a requirement). The

“cumulative ATP with look-ahead” calculation method includes all issues until the cumulative quantity to receive

exceeds the cumulative quantity to issue. Therefore, this ATP calculation method evaluates whether some of the

quantity from an earlier period can be used in a later period.

The ATP quantity is the uncommitted inventory balance in the first period. Typically, it's calculated for each

period in which a receipt is scheduled. The program calculates the ATP period in days and calculates the current

date as the first date for the ATP quantity. In the first period, ATP includes on-hand inventory minus customer

orders that are due and overdue.

ATP is calculated by using the following formula:

ATP = ATP for the previous period + Receipts for the current period – Issues for the current period – Net issue

quantity for each future period until the period when the sum of receipts for all future periods, up to and

including the future period, exceeds the sum of issues up to and including the future period.

Notice that the ATP calculation does not include information around expiry date and beyond the ATP time fence
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NOTENOTE

that the system expects when any quantity can be promised.

When there are no more issues or receipts to consider, the ATP quantity for the following dates is the same as

the latest calculated ATP quantity.

If not all the dimensions that are used for an item are given when the ATP check is completed, they can still be

specified on the issue and receipts. In this case, in the ATP calculation, the receipts and issues must be

aggregated to the existing dimensions to reduce the number of receipt and issue lines that are used in the ATP

calculation.

The ATP quantity that is shown is always greater than or equal to 0 (zero). If the calculation returns a negative

ATP quantity (for example, if the quantity that was previously promised exceeds the available quantity), the

quantity is automatically set to 0.

The ATP backward demand time fenceATP backward demand time fence field controls how far back in time to look for delayed demand

orders or inventory issues. The ATP backward supply time fenceATP backward supply time fence field controls how far back in time to look

for delayed supply orders or inventory receipts. For example, if orders that are delayed by only seven days

should be considered in the ATP calculation, both fields should be set to 77 .

The ATP delayed demand offset timeATP delayed demand offset time and ATP delayed supply offset timeATP delayed supply offset time fields control when the

delayed demand or supply will be considered in the ATP calculation. For example, if the delayed supply and

demand should be considered in the ATP calculation the day after tomorrow, both fields should be set to 22 . A

value of 22  means that the quantity of an item on a delayed purchase order that should be considered in the ATP

calculation will be seen as available two days after the current date.

For the following example, 77  is entered in the ATP backward demand time fenceATP backward demand time fence and ATP backwardATP backward

supply time fencesupply time fence fields, and 11  is entered in the ATP delayed demand offset timeATP delayed demand offset time and ATP delayedATP delayed

supply offset timesupply offset time fields.

A purchase order for 200 pieces of a product that should have been received three days ago hasn't been

received yet. Therefore, a sales order line for 75 pieces of the same product that should have been shipped

yesterday hasn't been shipped.

A customer calls and wants to order 150 pieces of the same product. When you verify the availability of the

product, you find that another purchase order for 100 pieces of the product will be delivered 10 days later.

You create a sales order line for the product and enter 150150  as the quantity.

Because the delivery date control is method is ATP, the ATP data is calculated to find the earliest possible ship

date. Based on the settings, the delayed purchase order and sales order are considered, and the resulting ATP

quantity for the current date is 0. Tomorrow, when the delayed purchase order is expected to be received, the

ATP quantity is calculated as more than 0 (in this case, it's calculated as 125). However, 10 days from now, when

the additional purchase order for 100 pieces is expected to be received, the ATP quantity becomes more than

150.

Therefore, the ship date is set to 10 days from now, based on the ATP calculation. Therefore, you tell the

customer that the requested quantity can be delivered 10 days from now.
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Example: Order entry deadline

Example: Different order entry deadlines per site

SIT E  ASIT E  A SIT E  BSIT E  B

California Florida

PST (Pacific Standard Time) EST (Eastern Standard Time)

This article provides information about order entry deadlines. An order entry deadline is a cut-off time that

determines whether a customer order is treated (and fulfilled) as if it was received on the current day or the next

day.

In many companies, only sales orders that are received before a certain time of day are treated as if they were

received on that day. Any orders that are received after that time are treated as if they are received on the next

business day. This cut-off time for orders is known as the order entry deadline.

Order entry deadlines are used as input for order promising. Therefore, they help you manage customer

expectations about order deliveries. For example, customers can see that, if they place an order with you before

a specific time, you will commit to shipping the goods on the same day. However, if they miss that deadline, they

can expect the shipment only on the next business day. You set order entry deadlines based on your warehouse

capabilities and shipping carrier schedules.

On the Order entr y deadlinesOrder entr y deadlines  page, you set up order entry deadline times for all the days of the week. If

orders are received after the specified times, they are treated as if they are received on the next day. By default,

these times are set to 23:59 (that is, one minute before midnight at the end of the relevant day). You can change

the default times so that they coincide with actual ship or receipt deadline times.

You can define order entry deadlines for a specific group of customers. For example, you might want a specific

group of customers to have order entry deadlines that are later than those of other customers. In this case, you

first define groups for order entry deadlines on the Order entr y deadline groupsOrder entr y deadline groups  page. You then assign the

groups to customers on the CustomersCustomers  page.

If your company consists of several sites, you can set up order entry deadlines for each site. If the sites are

located in different time zones, the order entry deadlines are set up in each site's time zone. However, when you

work with sales orders and sales quotations, the order entry deadline is converted to your time zone on the

Available ship and receipt datesAvailable ship and receipt dates  page.

On the Activate order entr y deadline combinationsActivate order entr y deadline combinations  page, you define the combinations of sites and order

entry deadline groups that are allowed.

The order entry deadline on Tuesdays has been set to 16:00. On a particular Tuesday, at 17:00, you try to set the

current date as the ship date. (Note that there is no lead time for this example.) If the Deliver y date controlDeliver y date control

check box is selected, you receive a warning that states that the date isn't valid. This warning appears on the

Available ship and receipt datesAvailable ship and receipt dates  page, where you can then select alternative dates.

Your company consists of two sites. The sites are located in different time zones, as shown in the following table.
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DAY  O F  T H E W EEKDAY  O F  T H E W EEK A :  O RDER EN T RY  DEA DL IN ES ( P ST )A :  O RDER EN T RY  DEA DL IN ES ( P ST ) B :  O RDER EN T RY  DEA DL IN ES ( EST )B :  O RDER EN T RY  DEA DL IN ES ( EST )

Monday 13:00 14:00

Tuesday 13:00 14:00

Wednesday 13:00 14:00

Thursday 13:00 14:00

Friday 13:00 14:00

SIT E  A :  P STSIT E  A :  P ST SIT E  A :  M STSIT E  A :  M ST SIT E  B :  ESTSIT E  B :  EST SIT E  B :  M STSIT E  B :  M ST

13:00 14:00 14:00 12:00

Example: Same order entry deadline per site

SIT E  ASIT E  A SIT E  BSIT E  B

California Florida

PST (Pacific Standard Time) EST (Eastern Standard Time)

DAY  O F  T H E W EEKDAY  O F  T H E W EEK P ST  A N D ESTP ST  A N D EST

Monday 13:00

Tuesday 13:00

Wednesday 13:00

Thursday 13:00

Friday 13:00

Sites A and B have defined the following order entry deadlines.

You're an order processor in Utah, where the time zone is MST (Mountain Standard Time). Therefore, provided

that you place orders with site A before 14:00 MST and place orders with site B before 12:00 MST, you meet the

order entry deadlines for both sites.

The following table shows how the order entry deadlines for sites A and B are converted to MST time.

Note:Note: If adjustment for daylight saving time is in effect, the order entry deadlines are adjusted accordingly.

Your company consists of two sites. The sites are located in different time zones, as shown in the following table.

Sites A and B have defined the following order entry deadlines.

You're an order processor in Utah, where the time zone is MST. Therefore, provided that you place orders with

site A before 14:00 MST and place orders with site B before 11:00 MST, you meet the order entry deadlines for

both sites.



SIT E  A :  P STSIT E  A :  P ST SIT E  A :  M STSIT E  A :  M ST SIT E  B :  ESTSIT E  B :  EST SIT E  B :  M STSIT E  B :  M ST

13:00 14:00 13:00 11:00

Additional resources

NOTENOTE

The following table shows how the order entry deadlines for sites A and B are converted to MST time.

Note:Note: If adjustment for daylight saving time is in effect, the order entry deadlines are adjusted accordingly.

Delivery schedules
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Open the Delivery alternatives page

Delivery date control methods

MethodMethod DescriptionDescription

NoneNone

Sales lead timeSales lead time

Sales order takers can use the Deliver y alternativesDeliver y alternatives  page to discover alternative order fulfillment options.

The Deliver y alternativesDeliver y alternatives  page layout gives an overview of all alternative options. It also lets order takers look

beyond the current company for fulfillment opportunities. They can now view both intercompany opportunities

and opportunities from external vendors. By sorting the options by delivery date, sales order takers can view an

intelligent list of delivery alternatives. In addition, parameters help them better manage the suggested deliveries.

Because transport time can affect delivery dates, sales order takers can explore the various transportation

choices that carriers offer. Because detailed information is shown for each suggestion, order takers can make

informed decisions directly from the Deliver y alternativesDeliver y alternatives  page.

You can open the Deliver y alternativesDeliver y alternatives  page from the sales order line.

1. Select Products and supply > Deliver y alternativesProducts and supply > Deliver y alternatives .

2. Select L ine details > Deliver y > Deliver y alternatives.L ine details > Deliver y > Deliver y alternatives.

You can also open the Deliver y alternativesDeliver y alternatives  page by opening the Sales order processing and inquir ySales order processing and inquir y

workspace, and then selecting Orders and favorites > Delayed order lines > Deliver y alternativesOrders and favorites > Delayed order lines > Deliver y alternatives

Note:Note: You can open the Deliver y alternativesDeliver y alternatives  page only if both the following conditions are met:

All mandatory sales line information is filled in.

The Deliver y date controlDeliver y date control  field is set to a value other than NoneNone.

The delivery date control method determines how the system establishes delivery dates, how delivery

alternatives are calculated, and what information is shown. Note that delivery date control takes calendars into

consideration. Therefore, the following calendars can affect the suggested receipt date: Warehouse calendar,

Transport calendar, Vendor calendar, and Customer calendar. The following table describes each method for

delivery date control.

Delivery alternatives for sales lines aren't supported.
This option turns off delivery date control.

Delivery alternatives are calculated based on the
predefined sales lead time. The transport days are
calculated based on the mode of delivery.

Delivery alternatives include warehouses that have
on-hand inventory, and supply/demand orders.
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ATPATP

ATP + Issue marginATP + Issue margin

CTPCTP

View information about delivery alternatives

The Product FastTabThe Product FastTab

The Delivery alternatives FastTabThe Delivery alternatives FastTab

Delivery alternatives are calculated based on available
to promise (ATP) logic. The current availability and
expected future availability are considered. The
transport days are calculated based on the mode of
delivery.

Delivery alternatives include warehouses that have
on-hand inventory, and supply/demand orders.

Delivery alternatives are calculated as for the ATP
method, but the issue margin is included in the
calculation.

Delivery alternatives are calculated based on the
capable to promise (CTP) logic. MRP explosion is used
to determine availability. Note that, at a minimum,
CTP offsets delivery dates to the sales lead time. The
transport days are calculated based on the mode of
delivery.

Delivery alternatives include suggestions for the
following warehouses:

Current warehouse

Default warehouse

All warehouses that have available on-hand
inventory

All warehouses that have supply orders

All warehouses that have active bill of
materials (BOM) versions

This section describes the information about delivery alternatives that is available on each FastTab of the

Deliver y alternativesDeliver y alternatives  page.

This FastTab shows a summary of the product and details of the current sales line.

This FastTab shows a list of delivery alternatives that is sorted by receipt date. Above the list, you can select

which options to base the suggestions on. You can also select the mode of delivery, which determines the

transport days. The following options are available:

Include other product var iantsInclude other product var iants  - This option is available for products that have product variants. It will

include delivery alternatives for other variants of the product. This option isn't available for CTP.

Include par tial quantityInclude par tial quantity  - By default, only suggestions that fulfill the full quantity of the sales line are

included. Select this option to include suggestions that only partially fulfill the order line. This option is useful

when the customer requests an earlier delivery date and accepts partial delivery.

Include later datesInclude later dates  - By default, only suggestions that are better (earlier) than the current dates on the

sales line are shown. Select this option to include later dates. This option can be useful in situations where

parameters other than the date have priority. For example, a specific vendor or warehouse might be

preferred.

Mode of deliver yMode of deliver y  - Select the preferred mode of delivery to optimize transport time and cost. You will

immediately see the effect on the suggested delivery alternatives. Therefore, it's easy to compare the

alternatives.

Include procurementInclude procurement - When procurement is selected, the suggested delivery alternatives include options



The Availability information FastTabThe Availability information FastTab

The Impact of selected alternative FastTabThe Impact of selected alternative FastTab

Additional resources

to procure from both external vendors and other companies in the enterprise (intercompany). The IncludeInclude

procurementprocurement option is supported for ATP and ATP + Issue margin delivery date control. Procurement

options from the default purchase vendor for the product and all approved vendors for the product are

included.

For external vendors, the calculation is based on the purchase lead time.

For intercompany, the calculation considers what is available from the sourcing company, based on delivery

date control in the sourcing company.

Deliver y typeDeliver y type (Relevant for procurement)

StockStock - Products are shipped from the sourcing warehouse to the site/warehouse on the sales line.

They are then shipped from that warehouse to the customer.

Direct deliver yDirect deliver y  - Products are shipped directly from the sourcing warehouse to the customer.

Information on this FastTab is related to the delivery alternative line that is selected. The following information is

shown, depending on the delivery date control for the sales line:

Sales lead timeSales lead time

Available todayAvailable today  - Show the current physical on-hand, physical reserved, and available physical

inventory.

ParametersParameters  - Show the inventory unit and sales lead time.

ATP and ATP + Issue marginATP and ATP + Issue margin

Available todayAvailable today  - Show the current physical on-hand, physical reserved, and available physical

inventory.

ParametersParameters  - Show the inventory unit and sales lead time.

Future availabilityFuture availability  - Show a graphical representation of current and future availability for the

selected site and warehouse under Deliver y alternativesDeliver y alternatives . You can select the chart columns to see

more detailed information about the future availability of the product. The slider shows a list of

relevant demand and supply orders within the ATP time fence.

CTPCTP

Available todayAvailable today  - Show the current physical on-hand, physical reserved, and available physical

inventory.

ParametersParameters  - Show the inventory unit and sales lead time.

ExplosionExplosion - Show a supply explosion of the selected delivery alternative. You can use SetupSetup to

change the fields and inventory dimensions that are shown in the explosion.

This FastTab highlights the impact of the selected delivery alternative. If you select OKOK, the sales line is updated

with the highlighted values in the SELECTED columns. Note that, if the quantity on the selected delivery

alternative is less than quantity on the sales line, a delivery schedule is created, and the order line is split into

two lines: one line for the selected quantity and one line for the remaining quantity. You can also update the

commercial line so that it matches the schedule lines and affects the pricing.

Order promising
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Delivery date

Delivery address

Deleting order lines

Warehouse

This article provides information about direct deliveries. Direct deliveries are deliveries that are sent directly

from the vendor to your customer.

Direct deliveries save delivery time and reduce the costs that are associated with carrying inventory, because

you don't hold the products in your warehouse before you ship them to the customer.

You can create direct deliveries from the Sales orderSales order  page. First, create a sales order and order lines. Then, on

the Action Pane, on the Sales orderSales order  tab, select Direct deliver yDirect deliver y . Finally, specify the lines that must be handled

as a direct delivery. A link is now created between the sales order lines for the direct delivery and the

corresponding purchase order lines.

Note:Note: If part of the ordered quantity has already been delivered, you must split the remaining quantity. Create a

new line for the quantity that must be directly delivered, and subtract that quantity from the quantity on the

original line. For example, if the original quantity was 15, and five have been delivered, you must create a new

line for the remaining quantity, 10, and then reduce the original quantity by that amount.

After you create the direct delivery link between the sales order lines and the purchase order lines, you can

update the sales order by using a packing slip. Run either a packing slip update or an invoice update from the

purchase order. You must invoice-update the sales order from the Sales orderSales order  page. An invoice update can't

cause the quantity on the sales order to exceed the quantity that has been registered as received. For example, a

sales order line has 10 pieces, but only five pieces from the sales order line have been updated by using a

packing slip. If you select AllAll  in the QuantityQuantity  list when you invoice-update the sales order, only those items that

have been physically received, or updated by using a packing slip, are invoice-updated. The whole sales order

line isn't updated.

When you update the Requested receipt dateRequested receipt date field on the sales order line, the Deliver y dateDeliver y date field on the

corresponding purchase order line is also updated. Similarly, when you update the ConfirmedConfirmed field on the

purchase order line, the Confirmed receipt dateConfirmed receipt date and Confirmed ship dateConfirmed ship date fields on the corresponding sales

order line are also updated.

Typically, the delivery address for a purchase order is the company's address. However, when you create a direct

delivery, you enter the customer's address as the delivery address. If you change the delivery address on a

purchase order line that has a delivery type of Direct deliver yDirect deliver y , the delivery address on the corresponding sales

order line is also updated. Similarly, if you change the delivery address on the sales order line, the delivery

address on the purchase order line is also updated.

If you try to delete a sales order line that has a delivery type of Direct deliver yDirect deliver y , a message box states that

purchase order lines are attached to the line. If the sales order line has been partially delivered, you can't delete

the sales order line or the purchase order lines that are attached to it.
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When you create a direct delivery, the items that you sell never physically arrive at your warehouse. However,

you must still specify a warehouse on the sales order line. Similarly, picking requirements might be specified on

the item model group for the item. However, because the items never physically arrive at your warehouse, these

requirements are ignored when the sales order is a direct delivery.
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Total order (original order line) 600 chairs

Requested delivery schedule 100 chairs per month

Requested time frame for delivery 6 months, on the first day of each month

Delivery schedules allow you to track order line quantity when you are using multiple deliveries for a single

sales order, sales quotation, or purchase order.

Use a delivery schedule when the total quantity on an order or quotation line must be delivered in multiple

shipments. Individual shipments are represented by delivery lines. Two or more delivery lines make up one

delivery schedule. The delivery lines can have different delivery dates, quantities, modes of delivery, and storage

dimensions, such as site and warehouse.

Example of a deliver y scheduleExample of a deliver y schedule

In this scenario, the customer requests delivery of 600 chairs in batches of 100 chairs over a period of six

months. To keep track of the delivery requirements, you create a delivery schedule. On the delivery schedule

page, you create six separate delivery lines. Each delivery line contains 100 chairs and indicates the delivery date

for those 100 chairs. In this case, each line is offset on the first of the month for six consecutive months.

When you create a delivery schedule, the type of the original order line is automatically changed to Order lineOrder line

with multiple deliver ieswith multiple deliver ies . A line of this type is referred to as a commercial line and is marked by an icon. The

delivery line is marked by a different icon. If you change a quantity on a delivery line, the commercial line is

updated to the total quantity of the delivery schedule. If a trade agreement has defined a total discount for the

order, the delivery schedule ensures that your order is eligible for the total order discount, even when the order

is split into separate deliveries.

Orders that have a delivery schedule are processed against the delivery lines. Processing includes the posting of

packing slips, product receipts, and invoicing.

Document printouts of orders and quotations that have a delivery schedule show only the delivery lines. They

don't show the original lines (commercial lines). Note:Note: In addition, only the delivery lines are shown when you

perform these actions:

Post

Copy pages

Browse list pages and reports

When you confirm sales quotations, the resulting sales orders show the whole delivery schedule, even the order

lines that have multiple deliveries. In addition, the whole delivery schedule is shown on all the major pages, such

as sales orders, sales quotations, and purchase orders.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/delivery-schedules.md


NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create delivery schedule
2/18/2021 • 2 minutes to read • Edit Online

Create delivery schedule

This procedure demonstrates how to create a delivery schedule for a sales order. A delivery schedule is used

when a quantity on an order or a quotation is requested to be delivered in multiple shipments. You can run this

procedure in demo data company USMF or on your own data.

1. Go to All sales orders.

2. Click New.

3. In the Customer account field, enter or select a value.

4. Click OK.

5. In the Item number field, enter or select a value.

6. In the Quantity field, enter a number that is bigger than 1.

7. Click Sales order line.

8. Click Delivery schedule.

9. In the Quantity field, enter a number that is part of the total quantity.

10. Click New.

11. In the Quantity field, enter the remaining quantity.

12. In the Requested ship date field, enter a date a date that is one week ahead from the date of the first delivery

line.

13. Move the cursor away from the second delivery line to update the page.

14. Click OK.

The Delivery schedule page is the place where you can specify the number of shipments in which the

total quantity of the order line will be delivered to the customer.

By default, the system copies the total quantity and other delivery details of the original sales line into

the first delivery schedule line. In this example, we'll create a schedule for two shipments, with the

second shipment's date offset by a week from the first one.

The two options on the Charges conversion FastTab control how you want the charges to be

distributed across the delivery schedule lines, once they've been assigned to the original order line. If

you select Copy gross amounts, the same charge amount is copied to each line. The Allocate to

delivery lines option divides the charge equally across the delivery lines.

Only fixed charges can be divided, whereas variable charges will still be copied to the lines.

You can keep track of the total quantity that's allocated to the delivery schedule lines by looking at the

Total and Remaining fields. When the remaining quantity is zero, the full quantity from the original line

has been allocated to the schedule.

The delivery schedule has now been copied to the order lines.

The original order line, referred to as a Commercial line, has been converted to an Order line with

multiple deliveries. It is marked with a distinct icon and acts as a header for the delivery lines.

The two new lines, referred to as delivery lines, make up one delivery schedule. The order will be

processed against these lines and not the original line. If documents such as confirmation slips,

picking lists, packing slips, or invoices are printed, only the delivery lines are shown.

The delivery lines can have different delivery dates, quantities, modes of delivery, and storage

dimensions, such as site and warehouse. However, the product dimensions must always match the

ones on the commercial line and can't be changed.
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15. In the Quantity field, enter a number that's bigger than the current one.

16. Select the commercial line to see the effect of the quantity recalculation.

17. On the Action Pane, click Pick and pack.

18. Click Post packing slip.

19. Expand the Parameters section.

20. In the Quantity field, select 'All'.

21. Select Yes in the Print packing slip field.

22. Click OK.

23. Click Yes.

24. Close the page.

Note that the packing slip will be created for the two delivery schedule lines and not the original order

line.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Working with serialized items
2/18/2021 • 6 minutes to read • Edit Online

When do I register serial numbers during the sales process?

Can I enter serial numbers by scanning them, or do I have to type
them?

If I enable serial numbers for the sales process, do I have to register
all serial numbers for all items?

This topic explains how you can register serial numbers on packing slips or invoices during the sales process.

This functionality is useful if a company wants to capture serial numbers for service and warranty purposes, but

doesn't have to maintain serial numbers in inventory from receipt to issue.

Many companies just want to capture serial numbers for service and warranty purposes, and don't have to

maintain serial numbers in inventory from receipt to issue. In these scenarios, you can register the serial

numbers on the packing slips or invoices when products are sold. If products are later returned, you can trace

each product to an invoice to determine whether you sold the product, and whether the service or warranty

obligations are valid.

You must enable serial numbers for the sales process by selecting the Active in sales processActive in sales process  option on the

Tracking dimension groupsTracking dimension groups  page. The following events then occur in Supply Chain Management:

On the Ser ial numbersSerial numbers  FastTab, the Ser ial number controlSer ial number control  option is selected. When this option is

selected, you must register one serial number for each item on the packing slip or invoice.

All selections on the tracking dimension group for serial numbers are cleared, except the Blank issueBlank issue

allowedallowed option. You can select the Blank issue allowedBlank issue allowed option to override the serial number control, and

allow products to be packed and invoiced without registering serial numbers.

You can register serial numbers either on the packing slip for a sales order or on the invoice. When you prepare

an invoice for a serialized item that was shipped together with a packing slip, you can select which serial

numbers on the packing slip to invoice. The number of registered serial numbers must not exceed the quantity

of items that were shipped. If you're creating a partial invoice, you can select fewer serialized items than were

registered on the packing slip. When you print a packing slip or an invoice, the serial numbers that were

registered are included.

You can either scan or type serial numbers. When you use a scanner, the scan mode determines whether the

serial numbers are added to or removed from the list of serial numbers on the invoice or packing slip. If you

want to scan serial numbers  by using, for example, a hand-held bar code scanner, configure the scanner to send

an Enter or TAB command after the serial number. This command will indicate the end of the data stream.

Otherwise, you must press Enter or TAB on the keyboard after you scan each serial number.

The setup of the tracking dimension group that is assigned to the product determines whether serial numbers

must be registered for all items on a packing slip or invoice. When you enable serial numbers for the sales

process, the Ser ial number controlSer ial number control  option is automatically selected. You must then register one serial number,

or register a blank registration for an unreadable number, for each item on the packing slip or invoice. If you

don't want to require a serial number for each item, select the Blank issue allowedBlank issue allowed option on the tracking

dimension group that is assigned to the item. You can then register fewer serial numbers than the quantity of

items that are being shipped. If you register more serial numbers than the quantity of items that are being
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Can I register serial numbers for partial invoices and partial
shipments?

What do I do when a serial number isn't readable?

Can I correct or change the serial numbers that I have registered for a
sales order?

Can I view the serial numbers that were shipped together with a
specific packing slip, or that were included on an invoice?

Can I view the serialized items that I have on hand?

Can I register serial numbers for catchweight items?

Can I register serial numbers at the retail POS?

shipped, you won't be able to post the packing slip or invoice.

You can create partial invoices and packing slips for sales orders, and register only the serial numbers for the

items that those invoices and packing slips include. If you want to create a partial invoice, and you have more

than one packing slip for the sales order, you can include serial numbers from more than one packing slip.

However, there can be only one packing slip that doesn't include all serial numbers. For example, if you have

three packing slips, and each packing slip includes two serialized items, you can't create a partial invoice for one

item from each packing slip.

If a serial number can't be read or scanned, you can create a blank line for the item by clicking Not readableNot readable on

the Ser ial numbersSerial numbers  page. If the serial number becomes available later, you can update the invoice or packing

slip. For more information, see the next section, “Can I correct or change the serial numbers I have registered for

a sales order?”

Yes, you can correct serial numbers if the following conditions are met:

InvoicesInvoices  – You can change the serial numbers for items that you haven't yet invoiced. The packing slip is

then also updated. However, if a sales order line was corrected by registering a negative quantity, you can't

change serial numbers for the sales order line.

Packing slipsPacking slips  – You can't partially correct a packing slip line that contains serialized items. You must reverse

the full quantity for the line. If a packing slip has been canceled or corrected, you don't have to register the

reversed serial numbers again when you create a new packing slip for the same serialized items. The

numbers that were registered will be used.

Yes, you can run an inquiry on the packing slip journal line or invoice journal line to view a list of all serial

numbers that were included in the document.

No, you can't view the serialized items that you have on hand, because serial numbers aren't registered for items

until the items are sold.

No, you can't register serial numbers for catch-weight items during the sales process. Additionally, if a product is

set up as a catch-weight item, you can't assign the product to a tracking dimension group that is set up to use

serial numbers only during the sales process.

Yes, the retail point of sale (POS) will prompt the user to enter a serial number when the user sells an item that is

assigned a tracking dimension group that is set up to use serial numbers only during the sales process.



What security roles are required in order to register serial numbers
during the sales process?

NOTENOTE

This functionality is available to all roles that can maintain sales packing slips and sales invoices. The following

duties let workers correct serial numbers, and register blank entries for serial numbers that can't be read or

scanned:

Maintain serial number corrections

Maintain registration of non-readable serial numbers

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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NOTENOTE

This article explains how to set up a product to allow reservation of inventory against a single batch of

inventory.

Same batch reservation lets you reserve inventory for a sales order line against a single batch of inventory. For

example, a customer who orders wallpaper can request that the whole order be filled from the same batch or

lot, to avoid inconsistencies among the rolls. To set up a product to use same batch reservation, the following

settings must be active in the item model group, tracking dimension group, and storage dimension group that

you assign to the product:

Item model groupsItem model groups  – The item model group must have the Same batch selectionSame batch selection and ConsolidateConsolidate

requirementrequirement fields selected in the Reser vationReser vation field group for inventory policies.

Tracking dimensions groupsTracking dimensions groups  – The tracking dimension group must have the Coverage plan byCoverage plan by

dimensiondimension field selected for the batch number.

Storage dimensions groupsStorage dimensions groups  – The storage dimension group must have the Coverage plan byCoverage plan by

dimensiondimension field selected for S iteSite and WarehouseWarehouse.

When you reserve inventory for a product on a sales order line that is set up for same batch selection, the

system tries to reserve the ordered quantity from a single inventory batch. Any specific batch attribute

requirements are also considered. If the quantity can't be filled from a single batch, the Same batchSame batch

reser vation conflictreser vation conflict page appears. This page describes the issues and also the actions that you can take to

continue with the reservation. The following conditions might prevent the batch from being reserved:

The batch disposition code has Block reser vationBlock reser vation for sales flagged as BlockedBlocked.

The batch has expired, based on the expiration date and any applicable customer sellable days. The item can

still be considered for reservation if the item model group for the item is First Expiry First Out (FEFO) date–

controlled, and if the best-before date is selected as the pick criterion.

The batch doesn't have enough shelf-life days remaining, based on the expiration date and best-before date,

plus any customer sellable days.

For items associated with a storage dimension group that has Use warehouse management processesUse warehouse management processes

enabled, you can reserve specific batch numbers by using a reservation hierarchy with the batch number

inventory dimension defined above the location dimension. The Batch reser vationBatch reser vation page for sales and transfer

order lines also lets you select and reserve multiple lines based on the available batch numbers. For more

information about what to do if you are using a reservation hierarchy that has the batch number dimension

below the location, see Flexible warehouse-level dimension reservation policy.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Overview

View all sales ordersView all sales orders

View orders for a customerView orders for a customer

This topic provides information about the Sales ordersSales orders  mobile workspace. This workspace helps you stay up to

date about your sales orders anywhere and anytime.

This mobile workspace is intended to be used with the Finance and Operations mobile app.

The Sales ordersSales orders  mobile workspace lets you view detailed information about each sales order. This information

includes the status of the order, contact information for the customer, and contact information for the order

taker. The Sales ordersSales orders  mobile workspace provides an instant view of sales orders. You can view all sales

orders, view sales orders by customer, or view information about a specific sales order.

The mobile workspace provides two views to help you analyze sale orders in depth.

This view lists all sales orders.

Use one of the following filters to select the sales orders to view:

Search by sales order

Search by customer account

Search by customer name

Search by status

Search by release status

Search by created date and time

After you select sales orders, you can view the details of specific orders. Specifically, you can view the

following information:

Customer name and address information

Various dates for the sales order, such as the requested ship date and the confirmed ship date

Contact information for the order taker

Customer contact information

Order lines

Shipments that show how and when a sales order was shipped

This view lists sales orders by customer.

Use one of the following filters to view orders for a customer:

Search by name

Search by account

After you select a customer, you can view the following information:

Customer name and group

Customer contact information

Customer sales orders and details about those sales orders:

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/sales-orders-mobile-workspace.md


Prerequisites

Prerequisites if you use Supply Chain ManagementPrerequisites if you use Supply Chain Management

Prerequisites if you use Dynamics 365 for Operations version 1611 with platform update 3 or laterPrerequisites if you use Dynamics 365 for Operations version 1611 with platform update 3 or later

P REREQ UISIT EP REREQ UISIT E RO L ERO L E DESC RIP T IO NDESC RIP T IO N

Implement KB 4013633. System administrator KB 4013633 is an X++ update or
metadata hotfix that contains the
Sales ordersSales orders  mobile workspace. To
implement KB 4013633, your system
administrator must follow these steps.

Publish the Sales ordersSales orders  mobile
workspace.

System administrator See Publish a mobile workspace.

Download and install the mobile app

Sign in to the mobile app

Customer name and address information

Various sales order dates

Contact information for the order taker

Customer contact information

Order lines

Shipments that show how and when a sales order was shipped

The prerequisites differ, based on the version of Microsoft Dynamics 365 that has been deployed for your

organization.

If Supply Chain Management has been deployed for your organization, the system administrator must publish

the Sales ordersSales orders  mobile workspace. For instructions, see Publish a mobile workspace.

If Dynamics 365 for Operations version 1611 with platform update 3 or later has been deployed for your

organization, the system administrator must complete the following prerequisites.

1. Download the metadata hotfix
from Microsoft Dynamics
Lifecycle Services (LCS).

2. Install the metadata hotfix.

3. Create a deployable package
that contains the SCMMobileSCMMobile
model, and then upload the
deployable package to LCS.

4. Apply the deployable package.

Download and install the Finance and Operations mobile app:

For Android phones

For iPhones

1. Start the app on your mobile device.

2. Enter your Dynamics 365 URL.

3. The first time that you sign in, you're prompted for your user name and password. Enter your credentials.

4. After you sign in, the available workspaces for your company is shown. Note that if your system

administrator publishes a new workspace later, you will have to refresh the list of mobile workspaces.

file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/publish-mobile-workspace.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/migration-upgrade/download-hotfix-lcs.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/migration-upgrade/install-metadata-hotfix-package.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/create-apply-deployable-package.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/apply-deployable-package-system.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/mobile-apps/publish-mobile-workspace.html
https://go.microsoft.com/fwlink/?linkid=850662
https://go.microsoft.com/fwlink/?linkid=850663


View information about sales orders for a customer by using the Sales
order mobile workspace

NOTENOTE

1. On your mobile device, select the Sales ordersSales orders  workspace.

2. Select View orders for a customerView orders for a customer .

3. Use account or customer name information to find the customer.

4. Select the customer.

5. Select Contact informationContact information or Sales ordersSales orders . If you select Sales ordersSales orders , a list of sales orders for the

customer is shown.

6. Select Sales orderSales order . You can now view information about sales order lines, information about shipments,

customer contact information, and contact information for the order taker.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Set an individual order for direct delivery

This topic demonstrates how to create a direct delivery for a sales order. You use direct delivery when you want

to ship goods to the customer directly from your vendor, instead of shipping them to your own warehouse first.

You can run this procedure in demo data company USMF or on your own data. To successfully complete the

second sub-task "Create direct deliveries from the workbench", make sure that the item that you choose on the

sales order has a default Vendor specified on the Purchase FastTab of the Released product master.

1. Go to Navigation pane > Modules > Accounts receivable > Orders > All sales ordersNavigation pane > Modules > Accounts receivable > Orders > All sales orders .

2. Select NewNew .

3. Enter or select a value in the Customer accoundCustomer accound field, then select OKOK

4. Enter or select values in the Item numberItem number  and S iteSite fields, then select SaveSave.

5. On the Action Pane, select Sales orderSales order , then select Direct deliver yDirect deliver y . The Create delivery page lists all the

open sales order lines as copied from the sales order. You can review the order details, and if required, you

can modify details such purchase quantity and pricing terms before you create the direct delivery.

6. Select YesYes  in the Include allInclude all  field.

7. Enter or select a value in the Vendor accountVendor account field, then select OKOK. The message informs you that the

purchase order has now been created.

8. Expand the L ine detailsL ine details  section.

9. Select the Deliver yDeliver y  tab and verify that the Direct deliver yDirect deliver y  field is set to YesYes .

10. On the Action Pane, select GeneralGeneral .

11. Select Related ordersRelated orders .

12. Select the link in the Purchase orderPurchase order  field.

13. Expand the L ine detailsL ine details  section and select the AddressAddress  tab.

14. Select the Deliver yDeliver y  tab.

If you want to generate a direct delivery for only a subset of the sales order lines, select these

individually.

The Vendor accountVendor account field may or may not already be populated with a vendor number. If the default

vendor is set up for the product (on the associated Item coverage) then this vendor will be copied to

the line. Otherwise, you must enter a vendor manually. In this example, we'll select a new vendor in

the next step, even if one is already populated.

The delivery address for this purchase order line is the customer's delivery address and not your

company's address.

If you change the delivery address on either the purchase order line or the originating sales order line,

the address on the corresponding order line will be automatically updated.

Like the sales order line, the associated purchase order line type is also set to Direct delivery.

The purchase order line's Delivery date and the Confirmed delivery date are set to the Requested

receipt date and Confirmed receipt date of the originating sales order line respectively.

If you update any of these dates on either the purchase line or the sales line, the dates on the

corresponding order will be automatically updated.

The purchase order that is set to deliver goods directly to the customer is linked to the originating

sales order by means of a special association. This association imposes the rule that the packing slip

update of the sales order can't be done from the sales order itself and must be done by using the

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/tasks/ship-orders-direct-deliveries.md


Create direct deliveries from the workbench

15. On the Action Pane, select PurchasePurchase.

16. Select ConfirmationConfirmation.

17. Select OKOK.

18. On the Action Pane, select ReceiveReceive.

19. Select Product receiptProduct receipt.

20. In the Product receiptProduct receipt field, type a value.

21. Select OKOK.

22. On the Action Pane, select GeneralGeneral .

23. Select Related ordersRelated orders  and highlight the desired record.

24. Select OKOK.

25. Close the page.

26. Select OKOK. Close the pages and return to the home page.

purchase order. However, customer invoicing must be carried out from the sales order.

After the purchase order has been updated as received, or in other words, after the vendor has

shipped the goods to your customer's address, the status of the originating sales order is

automatically updated to Delivered.

The sales order can now be invoiced.

1. Go to Navigation > Modules > Accounts receivable > Orders > All sales ordersNavigation > Modules > Accounts receivable > Orders > All sales orders .

2. Select NewNew .

3. Enter or select a value in the Customer accountCustomer account field, then select OKOK.

4. Enter or select a value in the Item numberItem number  and sitesite fields.

5. Expand the L ine detailsL ine details  section, then select the Deliver yDeliver y  tab. Instead of creating a direct delivery as part of

the sales order processing as in the previous procedure, you can choose to hand over this task to a

purchasing professional. To include the sales order line in the direct delivery handling process, you must

mark the line for direct delivery.

6. Select YesYes  in the Direct deliver yDirect deliver y  field.

7. Select SaveSave.

8. Close pages until you return to the home page.

9. Enter Direct delivery  in the search bar.

If the item has already been set up for direct delivery by default, the field will automatically be set to

Yes at the order line entry. You can set up an item for direct delivery on the Released product's master

by setting the Direct delivery option to Yes and selecting a default Direct delivery warehouse.

Because the purchase order has not yet been created, the Direct delivery status is set to "To be direct

delivered".

The Direct delivery page acts as a workbench that provides the purchasing agent with an overview of

all the sales order lines that are to be direct delivered and it allows them to create the respective

purchase orders. In addition, they can view the open direct delivery orders and the confirmed orders

on the Confirmation and Delivery tabs.

After you have created a direct delivery order, it automatically moved to the Confirmation tab. You can

choose to confirm the order directly from this page. When the purchase is confirmed, it will

automatically move to the Delivery tab, from which you can registered its receipt.



NOTENOTE
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Post packing slip for an order

This topic explains how to update a sales order when products are shipped to the customer. The guide is

applicable to the fulfillment flow that is not set up for warehouse management (neither basic or advanced

warehousing), and therefore does not require product picking to be registered before shipment. You can run this

procedure on your own data or in demo data company USMF. In both cases, before you start this task, create a

sales order for an inventoried product with a quantity of greater than 1. To avoid a posting error, you need to

check that the product's on-hand quantity in the site and warehouse that you've selected on the order covers the

order quantity.

1. In the navigation pane, go to Modules > Sales and marketing > Sales orders > All sales ordersModules > Sales and marketing > Sales orders > All sales orders .

2. In the list, find and select the order you have created for this task.

3. On the Action Pane, select Pick and packPick and pack .

4. Select Post packing slipPost packing slip.

5. Expand or collapse the ParametersParameters  section.

6. In the QuantityQuantity  field, select AllAll .

7. Set the Pr int packing slipPrint packing slip option to YesYes . The Over viewOver view  tab contains a list of packing slips to be generated

in this posting. If you are shipping an individual order, there will typically be one packing slip. However, if that

order's lines are to be shipped from different sites, posting will automatically be split into the appropriate

number of documents. This is a mandatory condition that cannot be changed. Similarly, the posting will also

be split into multiple documents if the order's lines are to be shipped to different delivery addresses, and the

shipping policy is set up to require a split.

8. On the L inesLines  tab, select the row for the order line to be shipped.

9. In the UpdateUpdate field, enter a number lower than the original quantity.

10. Select OKOK.

11. Select YesYes .

12. Close the page.

13. On the Action Pane, select OptionsOptions .

14. Select Change viewChange view .

15. Select Header viewHeader view .

16. On the Action Pane, select GeneralGeneral .

17. Select L ine quantityL ine quantity .

Other options include Deliver nowDeliver now  and PickedPicked. If the order line is to be shipped partially and the

Deliver nowDeliver now  field on the order line contains a quantity, you would select Deliver nowDeliver now . If your

organization's fulfillment flow includes picking as a separate process that is managed by and

registered with a picking list, you would select PickedPicked.

Check that the PostingPosting option is set to YesYes .

If all of the lines on the order have been fully shipped, the order status changes from Open to

Delivered.

In this example, the order line has been shipped partially. This is why the the order status remains

Open.

The Document statusDocument status  field is set to Packing slip because at least one of the order lines have been

shipped.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/tasks/ship-sales-orders-without-warehousing.md


NOTENOTE

18. Close the page.

19. On the Action Pane, select Pick and packPick and pack .

20. Select Packing slipPacking slip. The Packing slip journalPacking slip journal  page contains all the packing slip documents that were

generated for your order. You can review details of each document and print them, if you wish.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Set up charges codes

Create charge groups

Based on the customer that you're working with or the item that you're selling, you might want to apply specific

additional charges. The charges feature in Microsoft Dynamics 365 Supply Chain Management helps you

automatically allocate charges to purchase orders or sales orders.

Automatic charges, or auto charges, are automatically applied when you create a sales order or a purchase

order. You can define auto charges for specific vendors, customers, groups of vendors, or items. You can also

define auto charges that apply to all vendors, customers, or items.

To allocate charges, you must first define charges codes.

1. Follow one of these steps:

For purchase orders: Go to Accounts payable > Charges setup > Charges codeAccounts payable > Charges setup > Charges code.

For sales orders: Go to Accounts receivable > Charges setup > Charges codeAccounts receivable > Charges setup > Charges code.

2. On the Action Pane, select NewNew  to create a charges code.

3. In the header of the new record, set the following fields:

NOTENOTE

Charges codeCharges code – Enter a code for the charges.

Descr iptionDescr iption – Enter a description of the charges.

Item sales tax groupItem sales tax group – Select an item sales tax group, if applicable.

ProrateProrate – Set this option to Yes if you want to prorate your charges. This option is available only

for sales orders.

Maximum amountMaximum amount – Enter the maximum amount that is allowed for the charges code. This field

is used to validate charges for vendor invoices. It's available only for purchase orders.

To turn on the functionality for validating charges for purchase orders, go to Accounts payable >Accounts payable >

Setup > Accounts payable parametersSetup > Accounts payable parameters . On the Invoice validationInvoice validation FastTab, in the InvoiceInvoice

validationvalidation section, set the Enable invoice matching validationEnable invoice matching validation option to Yes.

4. The PostingPosting FastTab includes DebitDebit and CreditCredit sections. Set the following fields, depending on the

ledger that you want to post the charges to:

TypeType – Select the type of account that you're posting to (Ledger, Customer, or Item).

PostingPosting – Select the type of postings to create (such as Broker fee or Customer settlement).

AccountAccount – Select the account to post the charge for.

5. On the Action Pane, select SaveSave.

Charge groups automatically allocate specific charges to a group of customers or vendors. The following

subsections describe how to create and assign these charge groups.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/procurement/automatic-charges-allocation.md


Charge groups for purchase ordersCharge groups for purchase orders

Charge groups for sales ordersCharge groups for sales orders

Define auto charges

To create charge groups for purchase orders, follow these steps.

1. Go to Accounts payable > Charges setup > Vendor charges groupAccounts payable > Charges setup > Vendor charges group.

2. On the Action Pane, select NewNew  to add a row to the grid, and then set the following fields:

Charges groupCharges group – Enter the name of the charge group.

Descr iptionDescr iption – Enter a description of the charge group.

3. On the Action Pane, select SaveSave.

4. Go to Accounts payable > Vendors > All vendorsAccounts payable > Vendors > All vendors , and either open an existing vendor or create a

new vendor.

5. On the Purchase order defaultsPurchase order defaults  FastTab, in the Purchase orderPurchase order  section, set the Charges groupCharges group field

to the charge group that you just created.

To create charge groups for sales orders, follow these steps.

1. Go to Accounts receivable > Charges setup > Customer charge groupsAccounts receivable > Charges setup > Customer charge groups .

2. On the Action Pane, select NewNew  to add a row to the grid, and then set the following fields:

Charges groupCharges group – Enter the name of the charge group.

Descr iptionDescr iption – Enter a description of the charge group.

3. On the Action Pane, select SaveSave.

4. Go to Accounts receivable > Customers > All customersAccounts receivable > Customers > All customers , and either open an existing customer or

create a new customer.

5. On the Purchase order defaultsPurchase order defaults  FastTab, in the Sales orderSales order  section, set the Charges groupCharges group field to

the charge group that you just created.

After your charges codes are set up, follow these steps to define the auto charges.

1. Follow one of these steps:

For purchase orders: Go to Procurement and sourcing > Setup > Charges > AutomaticProcurement and sourcing > Setup > Charges > Automatic

chargescharges .

For sales orders: Go to Accounts receivable > Setup > Charges setup > Auto chargesAccounts receivable > Setup > Charges setup > Auto charges .

2. In the list pane, in the LevelLevel  field, select the level where your auto charge applies:

Main – Apply charges to the order header.

Line – Apply charges to the order lines.

3. Select an existing auto charge to edit it, or select NewNew  to define a new auto charge.

4. In the Account codeAccount code list, select one of the following values to specify the scope of accounts that will be

affected:

Table – Assign charges to a specific customer or vendor.

Group – Assign charges to a miscellaneous charges group.

All – Assign charges to all customers or vendors.

5. In the Customer relationCustomer relation or Vendor relationVendor relation field, select a specific customer or vendor if you set the

Account codeAccount code field to Table. If you set the Account codeAccount code field to Group, select a customer or vendor



charges group.

6. In the Item codeItem code field, select one of the following values to specify the scope of items that will be

affected. You can select an item code only when you define auto charges at the line level.

Table – Assign charges to a specific item.

Group – Assign charges to an item charges group.

All – Assign charges to all items.

7. In the Item relationItem relation field, select a specific item if you set the Item codeItem code field to Table. If you set the ItemItem

codecode field to Group, select an item charges group.

8. For sales orders only:For sales orders only: In the Mode of deliver y codeMode of deliver y code field, select one of the following values to

specify the scope of delivery modes that will be affected:

Table – Assign charges to a specific mode of delivery.

Group – Assign charges to a mode of delivery group.

All – Assign charges to all modes of delivery.

9. For sales orders only:For sales orders only: In the Mode of deliver y relationMode of deliver y relation field, select a specific mode of delivery if you

set the Mode of deliver y codeMode of deliver y code field to Table. If you set the Mode of deliver y codeMode of deliver y code field to Group,

select a mode of delivery group.

10. On the L inesLines  FastTab, define the charges and the charges rates that will be used when the current auto

charge is applied. You can use the toolbar on this FastTab to add as many lines as you require. For each

line, set the following fields:

CurrencyCurrency  – Select the currency that should be used to calculate the charge.

Charges codeCharges code – Select the code for the charge.

Categor yCategor y  – Select one of the following values:

Fixed – The charge is entered as a fixed amount on the line. Fixed charges can be used on

charges both in the order header and on the order lines.

Pcs – The charge is based on the unit. These charges can be used only on order lines. They will

appear when you calculate the order total.

Percent – The charge is entered as a percentage on the line. Percentage charges can be used on

charges both in the order header and on the order lines.

Intercompany percent – The charge is entered as a percentage on the line for intercompany

orders. Intercompany percentage charges can be used only on order lines.

External – The charge is calculated by a third-party service that is associated with one or more

shipping carriers.

Charges valueCharges value – Enter the charge value, based on the category that you selected.

Charges currency codeCharges currency code – Specify a currency for the charge if you want to use a currency other

than the currency that you specified in the CurrencyCurrency  field. You can use a different currency only if

the Debit typeDebit type or Credit typeCredit type field is set to either Ledger account or Item for the selected

charges code.

From amountFrom amount – Specify a starting amount to apply the auto charge to. In this context, the amount

refers to the order total.

To amountTo amount – Specify the ending amount to apply the auto charge to. In this context, the amount

refers to the order total.

Sales tax groupSales tax group – Specify a sales tax group.

S iteSite and WarehouseWarehouse – Specify a site and warehouse if charges should be applied only for a



Allocate charges from the header to a line

specific site and warehouse.

KeepKeep – Select this check box to keep the charges transactions after invoicing is completed, so that

the charge will be applied every time that you create a new invoice for the selected customer

account.

11. For sales orders only:For sales orders only: If you want to calculate tiered charges, see Tiered charges on sales orders for

information.

The following procedure shows how to allocate header-level charges to a line. Before you start this procedure,

you should already have a header-level charge of the fixed amount type and an order where that charge is

applied. Additionally, the order should already include at least one line item.

1. Open the purchase order or charge order.

2. On the Action Pane, follow one of these steps:

For purchase orders: On the PurchasePurchase tab, in the ChargesCharges  group, select Allocate chargesAllocate charges .

For sales orders: On the SellSell  tab, in the ChargesCharges  group, select Allocate chargesAllocate charges .

3. In the Allocate charges to order linesAllocate charges to order lines  dialog box, set the following fields:

IMPORTANTIMPORTANT

Charges allocationCharges allocation – Select one of the following values to specify how the charges should be

allocated:

Net amount – Allocate charges according to each line amount relative to the total net amount.

Quantity – Allocate charges according to the number of units for each line relative to the total

number of units.

Per line – Allocate charges equally among the total number of lines.

Allocate charges to linesAllocate charges to lines  – Select a value to specify whether charges should be allocated to all

lines, to positive lines only, or to negative lines only.

Allocate allAllocate all  – Select this check box to allocate charges to order lines even if the charges code has

a debit type other than Item.

ReceivedReceived – Select this check box to allocate charges only to received order lines.

StockedStocked – Select this check box to allocate charges to only inventoried order lines.

Show selections and clear specific linesShow selections and clear specific lines  – Select this check box to exclude specific lines from

this allocation. When you select this check box, the Choose lines to exclude from allocationChoose lines to exclude from allocation

grid is opened. This grid includes only lines that match the criteria that are defined by the AllocateAllocate

charges to linescharges to lines  and StockedStocked settings. For example, if you set the Allocate charges to linesAllocate charges to lines

field to Positive lines and select the StockedStocked check box, the grid shows only lines that are both

positive and inventoried. In addition, the grid automatically filters out any lines that the full

quantity has already been received for. While the grid is open, clear the IncludeInclude check box for each

line that should be excluded from allocation.

When you work with the Choose lines to exclude from allocationChoose lines to exclude from allocation grid, be sure to leave the grid open

until you select AllocateAllocate. If you close the grid before you select AllocateAllocate, your settings in the grid will be

lost. Therefore, charges will be allocated based on the criteria that you previously defined.

4. Select AllocateAllocate to apply your settings and close the dialog box.

https://docs.microsoft.com/en-us/dynamicsax-2012/appuser-itpro/about-tiered-charges-on-sales-orders
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Create a purchase order from a sales order

This procedure shows you how to create a purchase order that is based on a sales order. The product's quantities

on the purchase order are then designated to fulfill the demand of the originating sales order. Fulfilling sales

demand this way is an alternative to a more comprehensive and optimized method of Distribution

Requirements Planning. You can run this procedure in demo data company USMF or on your own data.

1. Go to Navigation pane > Modules > Sales and marketing > Sales orders > All sales ordersNavigation pane > Modules > Sales and marketing > Sales orders > All sales orders .

2. Click NewNew .

3. In the Customer accountCustomer account field, click the drop-down button to open the lookup.

4. In the list, find and select the desired record.

5. Click OKOK.

6. In the Item numberItem number  field, click the drop-down button to open the lookup.

7. In the list, find and select the desired record. If you're using USMF, you could select D0001.

8. In the QuantityQuantity  field, enter a number.

9. Click Add lineAdd line.

10. In the Item numberItem number  field, click the drop-down button to open the lookup.

11. In the list, find and select the desired record. If you're using USMF, you could select T0020.

12. In the list, click the link in the selected row.

13. In the QuantityQuantity  field, enter a number.

14. Click SaveSave.

15. On the Action PaneAction Pane, click Sales orderSales order .

16. Click Purchase orderPurchase order . The Create purchase orderCreate purchase order  page lists all the open sales order lines which have

been copied from the sales order. You can review the order details, and if required, you can modify selected

details such purchase quantity and pricing terms, before you create the purchases.

17. Select the Include all optionInclude all option.

18. In the Vendor accountVendor account field, click the drop-down button to open the lookup.

19. In the list, find and select the desired record.

20. In the list, click the link in the selected row.

21. Select the second order line.

22. In the Vendor accountVendor account field, click the drop-down button to open the lookup.

23. In the list, find and select the desired record.

24. In the list, click the link in the selected row.

25. Click ValidateValidate.

26. Click OKOK. The message informs you that one or more purchase orders have been created. The system

If you want to generate purchase orders for only a subset of the sales order lines, select these

individually.

The Vendor accountVendor account field may or may not already be populated with a vendor number. If the default

vendor is set up for the product (on the associated Item coverage) then this vendor will be copied to

the line. Otherwise, you must enter a vendor manually. In this guide, regardless of whether the

Vendor accountVendor account field already contains a value or not, the following steps instruct you to select a new

vendor which is different for each line.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/tasks/create-purchase-order-sales-order.md


Review purchase orders created from sales orders

NOTENOTE

generates a separate purchase order for each vendor that you specified for the sales order lines. This means

that if several sales order lines are to be supplied by the same vendor, a single purchase order with multiple

lines will be generated.

1. On the Action PaneAction Pane, click GeneralGeneral .

2. Click Related ordersRelated orders . The Related ordersRelated orders  page lists all the orders that were created from the sales order. In

this example, there are two purchase orders generated for two different vendors respectively.

3. Click to follow the link in the Purchase orderPurchase order  field. Each purchase order line is associated with the sales

order line that led to the purchase. The relation to the sales order is indicated on the Product tabProduct tab in the L ineLine

detailsdetails  Fasttab, in the Reference typeReference type, Reference numberReference number , and Reference lotReference lot fields.

4. Expand or collapse the L ine detailsL ine details  section.

5. Click the ProductProduct tab.

The Reference lotReference lot guarantees that the costs from the current purchase are charged on the attached

sales order.

You can navigate to the originating sales order by opening the link in the Reference numberReference number  field.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Enter sales order header details

Enter sales order line details

This procedure shows you how to create a sales order. You can use the procedure in demo data company USMF.

Sales orders are typically created by a sales order processor.

1. Go to Navigation pane > Modules > Sales and marketing > Sales orders > All sales ordersNavigation pane > Modules > Sales and marketing > Sales orders > All sales orders .

2. Select NewNew .

3. In the Customer accountCustomer account field, select the drop-down button to open the lookup.

4. In the list, find and select the customer record.

5. Select OKOK.

For this example, select customer number US-004.

The products sold by your organization may come in variants differentiated by dimensions, such as

configuration, color, size, and style. Also, products may be set up to use storage dimensions, such as site,

warehouse, and pallet, and tracking dimensions, such as batch and serial numbers. When these dimensions are

assigned, you must select the values for those dimensions on the order line. To improve order entry efficiency,

you may want to add the respective dimension fields to the order grid.

1. Under the Sales order linesSales order lines  section, select the Sales order lineSales order line.

2. Select DimensionsDimensions .

For this example, select the Color, Site and Warehouse dimensions. The dimensions you select here will

appear in the sales order grid. If you want your selections to persist, set the Save setupSave setup option to Yes.

3. Select OKOK.

4. In the Item numberItem number  field, select the drop-down button to open the lookup.

5. For this example, select item number T0004.

If the item is part of a sales category, the item name will automatically appear in the Sales category

field.

If product dimension fields already contain a value, this is because the value was copied from the

product record where it is defined as a default product dimension. You can change the default value at

any time.

6. In the ColorColor  field, select the drop-down button to open the lookup.

7. In the list, find and select the desired record.

8. In the QuantityQuantity  field, enter a number.

If the item is sold in different units than when it's purchased, produced, and stored, and a sales unit of

measure is set on the product record, this value will be shown in the UnitUnit field. You can change the

value at any time.

If the S iteSite field already contains a value, the value was copied from the order header or from the

order settings that are associated with the product. You can change the value at any time. If the field is

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/tasks/create-sales-orders.md


Review the order totals

NOTENOTE

empty, select a value.

If the Unit pr iceUnit pr ice field already contains a value, the value was copied from a valid trade agreement, or

from the product record. (The unit price can also originate from a sales agreement, but the process for

creating sales orders from sales agreements is different to the one shown here.) If the field is empty,

enter a value.

The DiscountDiscount field contains a discount amount per product unit. To calculate the total line discount

amount, the discount value is multiplied by line quantity. If the DiscountDiscount field already contains a

value, the value was copied from a valid trade agreement. If the field is empty, and you want to give

the customer a line discount, enter a value.

The Discount percentDiscount percent field contains a percentage value by which the total line gross amount is to be

reduced. If the Discount percentDiscount percent field already contains a value, it was copied from a valid trade

agreement. If the field is empty, and you want to give the customer a line discount, enter a value.

The NetNet amount field contains a value that is calculated based on the line's quantity and unit price

adjusted by discounts. You can override the calculated value to a different one.

1. On the Action PaneAction Pane, select Sales orderSales order .

2. Select TotalsTotals .

The TotalsTotals  page displays details about the entire order. This includes the subtotal amount, which is a sum

of all line net amounts adjusted for eventual line discounts, the total invoice amount, which is a subtotal

amount adjusted for eventual order-level discount, charges, and sales tax, the customer credit limit

situation, and more. The invoice amount is the amount that will appear on the customer's invoice

document.

3. Select OKOK.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Set up order holds

Place order on hold

Manage order holds

This procedure demonstrates how to place customer sales orders on hold, how to work with order hold

checkouts, and how to remove order holds. An order might be placed on hold for a variety of reasons. For

example, you might hold an order until a customer address or payment method can be verified or until a

manager can review the customer's credit limit. While the order on hold, it cannot be processed by the

warehouse for shipping.

You can run this procedure in demo data company USMF or on your own data.

1. Go to Navigation pane > Modules > Sales and marketing > Setup > Sales orders > Order holdNavigation pane > Modules > Sales and marketing > Setup > Sales orders > Order hold

codescodes .

2. Click NewNew .

3. In the Hold codeHold code field, type a value. For example, type 'Call back'.

4. In the Descr iptionDescr iption field, type a value.

5. Click SaveSave.

For example, Order held waiting for customer callback.

Optionally, select the Remove reser vationsRemove reser vations  check box to remove any physical reservations from the

order when this hold code is added.

1. Go to Navigation pane > Modules > Sales and marketing > Sales orders > All sales ordersNavigation pane > Modules > Sales and marketing > Sales orders > All sales orders .

2. Click NewNew .

3. In the Customer accountCustomer account field, enter or select a value.

4. Click OKOK.

5. In the Item numberItem number  field, enter or select a value.

6. In the QuantityQuantity  field, enter a number.

7. On the Action PaneAction Pane, click Sales orderSales order .

8. Click Order holdsOrder holds .

9. Click NewNew .

10. In the Hold codeHold code field, select the code you have created in the previous subtask.

11. Click SaveSave.

12. Close the page.

13. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

14. In the list, mark the selected row. Orders that are currently on hold have the "Do not process" and "Hold"

fields marked.

15. On the Action Pane, click Pick and packPick and pack .

1. Go to Sales and marketing > Sales orders > Open orders > Order holdsSales and marketing > Sales orders > Open orders > Order holds . Order holdsOrder holds  page

functions as a workbench where you can get an overview of all the current and processed holds, and handle

them and associated sales orders.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/tasks/manage-order-holds.md
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2. In the list, mark the selected row.

3. On the Action PaneAction Pane, click Hold checkoutHold checkout.

4. Click Check outCheck out.

5. In the list, unmark the selected row. The Checkout out toCheckout out to field now shows your user ID.

6. Click Clear checkoutClear checkout.

7. On the Action PaneAction Pane, click Clear holdClear hold.

8. Click Clear holdsClear holds . The hold has now been cleared from the order and removed from the list of Active holds.

To see all the holds or their subset according to a specific status, change the value in the Show field.

When you are ready to remove the hold and allow the order to proceed to the next fulfilment step,

you must clear the hold. If the order requires no changes, you can run the Clear holds action. However,

you can use the Clear and modify action if, when clearing a hold, the order has to be updated.

The Clear and submitClear and submit action is only applicable when you use Call center functionality.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Confirm a single sales order

Confirm multiple sales orders at once

This procedure demonstrates how to confirm sales orders. You'll be shown how to confirm a single order, and

how to confirm multiple orders at once. These tasks would typically be carried out by a sales order processor.

You can use this procedure in demo data company USMF or on your own data. Before you start, make sure

there are several open sales orders for the same customer. If you're using USMF, you can use customer US-027.

1. Go to Navigation pane > Modules > Sales and marketing > Sales orders > All sales ordersNavigation pane > Modules > Sales and marketing > Sales orders > All sales orders .

2. In the list, find and select the order that you want to confirm.

3. Click the link on the sales order number to open the selected order.

4. On the Action PaneAction Pane, click SellSell .

5. Click Confirm sales orderConfirm sales order .

6. Expand the ParametersParameters  section. Make sure that the PostingPosting option is set to 'Yes'.

7. Set the Pr int confirmation optionPrint confirmation option to 'Yes'. The Check credit limitCheck credit limit field specifies the method that's used

to calculate a customer's remaining credit. By default, it's copied from the Accounts receivable parameters

page. If you want to skip the credit limit check when confirming a specific sales order, set the Check creditCheck credit

limitlimit to 'None'. However, you should be aware that even with if this field is set to 'None', the credit limit

check will still be performed if the Mandator y credit limitMandator y credit limit option is selected on the customer master data.

8. Click OKOK.

9. Click YesYes .

10. Close the page.

11. On the Action PaneAction Pane, click OptionsOptions .

12. Click Change viewChange view .

13. Click Header viewHeader view . When an order is confirmed, the Document statusDocument status  is set to 'Confirmation'.

14. On the Action PaneAction Pane, click SellSell .

15. Click Sales order confirmationSales order confirmation.

16. Close the page.

1. Go to Sales and marketing > Sales orders > Order confirmation > Confirm sales orderSales and marketing > Sales orders > Order confirmation > Confirm sales order .

2. Click SelectSelect.

3. In the list on the RangeRange tab, find and select the record that references the Customer accountCustomer account field.

4. In the Criter iaCriter ia field, click the drop-down button to open the lookup.

5. In the list, find and select the customer account that has multiple orders which you want to mass confirm. If

you're using USMF, you can select account US-027.

6. Click OKOK.

7. In the Summar y update forSummar y update for  field, select 'Order'. The minimum parameters that are required to create

The Over viewOver view  tab displays a list of the orders that match the query criteria. These will be included in

the confirmation.

The Summar y update forSummar y update for  field in the ParametersParameters  section specifies the parameter by which multiple

orders are to be summarized into one confirmation document. By default, the option is copied from

the Default values for summar y update settingefault values for summar y update setting on the Accounts receivable parametersAccounts receivable parameters  page.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/tasks/confirm-sales-orders.md
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summary updates are Invoice accountInvoice account and CurrencyCurrency . This means that summary updates that have

different invoice accounts and different currencies are not allowed. Additional parameters can be set up in

the Summar y update parametersSummar y update parameters  page which is accessible from the Accounts receivable parametersAccounts receivable parameters

page.

8. In the Sales orderSales order  field, click the drop-down button to open the lookup.

9. In the list, select the order number that you want to be the summary order.

10. Click ArrangeArrange.

11. Click OKOK.

12. Click OKOK.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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The tax information isn't updated if I change the location on a sales
order header.
Issue descriptionIssue description

Issue resolutionIssue resolution

If there are two trade agreements for the same period or overlapping
periods, the same agreement line is always selected.
Issue descriptionIssue description

Issue resolutionIssue resolution

Can I link a purchase order to a sales order to fulfill demand?

I can't cancel or delete a return order or a sales order.

When I try to cancel a sales order, I receive a "Reservations cannot be
removed because there is work created which relies on the
reservations" error.

This topic describes how to fix issues that you might encounter while you work with sales orders.

If the site, warehouse, or delivery address is changed either on a sales order header or at the line level, the case

tax information isn't automatically updated for the lines.

This behavior is by design. The issue occurs because the delivery address, site, and warehouse aren't

automatically changed at the line level either. You must update them manually.

If two trade agreements are defined for the same period or overlapping periods, the same trade agreement

seems to be selected every time when you create sales order lines that contain those items.

If there is more than one trade agreement for a given date, the trade agreement that has the lowest price is

always selected. For more information, download the following white paper : Trade agreements in Microsoft

Dynamics AX 2012.

You can create a purchase order from a sales order. For more information, see Create a purchase order from a

sales order.

You can cancel only sales orders and return orders that are in a Created state. For more information, see Cancel

a return order.

Error code: WAX4661

If work is associated with a sales order, you can't cancel the sales order until the work is canceled and reversed.

This requirement applies even if the work that is associated with the sales order is closed.

To fix this issue, follow these steps.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/troubleshooting-sales.md
https://www.axug.com/HigherLogic/System/DownloadDocumentFile.ashx?DocumentFileKey=3396a3a8-1f48-4d85-8cd6-5fa982f62e90


I can't cancel an intercompany purchase order that is linked to a sales
order.
Issue descriptionIssue description

Issue resolutionIssue resolution

Can I restore an invoiced sales order that was deleted?
Issue descriptionIssue description

Issue resolutionIssue resolution

The deadline of a sales order header can't be found in the
SalesOrderHeaderV2Entity data entity.

I must delete orphaned sales order records.

Is there a way to calculate commissions on invoices that have already
been posted?

A bundle item isn't supported in an intercompany process.

1. Cancel the work, and put inventory back into the desired location. Go to the relevant load of the sales

order, and select either Reduce picked quantityReduce picked quantity  on the load line or Reverse workReverse work on the Action Pane.

The work now has a status of Canceled, and new inventory movement work is automatically created and

processed to put inventory back into the location that was described at the time of reversal.

2. Delete the load. The shipment is also deleted.

3. You should now be able to go to the sales order and cancel it.

If you try to cancel an intercompany purchase order that is linked to a sales order, you might receive the

following error message: "Quantity cannot be reduced because the remaining update quantity changes sign."

This issue was fixed in Microsoft Dynamics 365 Supply Chain Management version 10.0.13. In that version and

later versions, you can now cancel an intercompany purchase order that is linked to a sales order.

An invoiced sales order was deleted by mistake, and you want to restore it or view its details.

If the deleted sales order has already been invoiced, go to Customer account > Transactions > OriginalCustomer account > Transactions > Original

document > View detailsdocument > View details . Find the invoice that you're looking for, and select it to view its details. These details

include the sales order reference. You should also be able to access the sales order details from that page.

The deadline field doesn't exist on the SalesOrderHeaderV2Entity entity.

To clean up orphaned sales order records, run the Sales order deletion periodic job by going to either of the

following places:

Sales and marketing > Periodic tasks > Clean up > Delete sales orders

Retail and commerce > Retail and commerce IT > Clean up > Delete sales orders

Supply Chain Management doesn't currently support the calculation of commissions for posted invoices.

The bundle item isn't available for the purchase order because, if you examine the sales order lines for the

bundle item, you will notice that the quantity is 0 (zero) and the status is Canceled. This behavior is by design.

The sales order buys only the components of the bundle item. It doesn't buy the bundle item itself.



NOTENOTE

If you must buy a bundle, consider whether you have to mark it as bundle item, because this functionality is

designed for revenue recognition scenarios. For more information about bundle items, see Bundles.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Commitment types

Pricing terms for sales agreements

This topic provides information about sales agreements. A sales agreement is a contract that commits the

customer to buy products in a specific quantity or for a specific amount over time, in exchange for special prices

and discounts.

A sales agreement is a contract that commits the customer to buy products in a specific quantity or for a specific

amount over time, in exchange for special prices, special discounts, and other special terms, such as payment

and delivery terms. The prices and discounts of the sales agreement override the prices and discounts that are

stated in any trade agreements that exist.

The validity period of a sales agreement is defined by the Effective dateEffective date and Expiration dateExpiration date fields on the

agreement. A customer's sales order qualifies for the agreement terms if the requested ship date of the order is

within the validity period. All sales order lines that are linked to a sales agreement contribute to fulfillment of

that sales agreement.

You can create a sales order directly from a sales agreement by using the Release orderRelease order  action. Alternatively,

you can select an effective sales agreement when you're taking orders (see the "Applying sales agreements in

the ordering process" section of this article).

[Note!] In earlier versions, sales agreements were referred to as blanket sales orders.

Each line in a sales agreement expresses a commitment to sell something. In general, there are two categories of

commitment:

Value commitmentValue commitment – The customer agrees to buy products for a specific amount.

Quantity commitmentQuantity commitment – The customer agrees to buy a specific quantity of products.

In addition, a contract can commit the customer to buy a specific product or products in a product category. By

combining these two factors (value versus quantity, and specific products versus product categories), we get

four types of commitment:

Product quantity commitmentProduct quantity commitment – The customer agrees to buy a specific quantity of products. Lines that

use this commitment type are defined by an item number, and by the quantity and unit that were agreed on.

The AmountAmount field isn't available.

Product value commitmentProduct value commitment – The customer agrees to buy specific products for a specific amount. Lines

that use this commitment type are defined by an item number and the amount that was agreed on. The

QuantityQuantity  and UnitUnit fields aren't available.

Product categor y value commitmentProduct categor y value commitment – The customer agrees to buy products from a specific sales

category for a specific amount. Lines that use this commitment type are defined by a sales category in the

hierarchy of sales categories and an amount. The QuantityQuantity  and UnitUnit fields aren't available.

Value commitmentValue commitment – The customer agrees to buy any product or products in any procurement category

for a specific amount. The QuantityQuantity  and UnitUnit fields aren't available.

Lines in the same sales agreement can have different types of commitments.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/sales-agreements.md
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Product quantity
commitment

Yes Yes Yes Yes

Product value
commitment

Yes

Product category
value commitment

Yes

Value commitment Yes

Policies for sales agreements

Fulfillment calculations for sales agreements

Confirmations and version history for sales agreements

Pricing terms can vary, depending on the type of commitment. On a sales order that is linked to a sales

agreement, the pricing terms from that sales agreement override any other pricing terms that apply based on

trade agreements. The following table describes the price-related fields that are affected by each commitment

type. "Yes" indicates that the field can be updated on an order line.

The following policies affect the way that the link between a sales agreement commitment and the

corresponding sales order lines works:

Max is enforcedMax is enforced – The total quantity or amount for all order lines can't exceed the quantity or amount that

is specified on the related commitment.

Pr ice and discount is fixedPrice and discount is fixed – The price on an order line and the price on the related commitment can't

differ. If the price is changed on the order line, the link to the commitment is broken. If the link is broken, the

order line doesn't contribute to fulfillment of the commitment.

Minimum release amountMinimum release amount and Maximum release amountMaximum release amount – If an amount is specified, a message is

displayed if you make any change to an order line that causes the order line to differ from the related

commitment.

The Fulfil lmentFulfillment tab on the L ine detailsL ine details  FastTab on the Sales agreementsSales agreements  page shows fulfillment quantities

and amounts.

In the Fulfil lmentFulfillment area, you can view the total quantities and amounts for all order lines that are linked to the

specified sales agreement. You can also view the remaining amount or quantity that is required to fulfill the

commitment.

In the AgreementAgreement area, you can view the quantities and amounts from the specified sales agreement. These

quantities and amounts are the total quantities and amounts that were committed.

When you confirm a sales agreement, the current version of the sales agreement is stored in a history table. If

you change the sales agreement, you can confirm it again to store another version of the sales agreement in the

history.

If you don't confirm a sales agreement, you can still use it to create sales orders. However, history information

for the sales agreement isn't stored.

You can preview or print all revisions of the confirmations. You can then share the revisions with your customer



Applying sales agreements during the ordering process

Modifying sales orders that are linked to sales agreements

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Requested ship date If you change the requested ship date to a date that is
earlier than the Effective dateEffective date value on the sales
agreement line, you must remove the link to the sales
agreement line before you can save the changed ship date. If
you change the requested ship date to a date that is later
than the Expiration dateExpiration date value on the sales agreement
line, you must remove the link to the sales agreement line
before you can save the changed ship date.

CurrencyDiscount, percentDiscountUnit, pricePrice, unitNet
amount

If you change the value in any of these fields, and if the
Price and discount is fixedPrice and discount is fixed check box is selected on an
associated sales agreement line, a message box prompts you
to save the change. Click YesYes to remove the link to the sales
agreement line and recalculate the price. Click NoNo to remove
the link to the sales agreement line without recalculating the
price.

Net amount If you specify an amount that exceeds the amount that is
specified on a sales agreement line where the Max isMax is
enforcedenforced check box is selected, a message box prompts you
to save the changed amount. Click YesYes to remove the link to
the sales agreement line and recalculate the price. Click NoNo
to remove the link to the sales agreement line without
recalculating the price.

Quantity If you specify a quantity that exceeds the quantity that is
specified on a sales agreement line where the Max isMax is
enforcedenforced check box is selected, a message box prompts you
to save the changed quantity. Click YesYes to remove the link to
the sales agreement line and recalculate the price. Click NoNo
to remove the link to the sales agreement line without
recalculating the price.

Returning an item that was ordered from a sales agreement

to obtain approval.

If you don't release sales orders directly for a sales agreement, you can still link a sales agreement to an order

during the order entry process. When you're creating a new sales order and select a sales agreement, the terms

of that agreement, such as the payment terms, delivery terms, and delivery address, are applied to the order

header, and the link between the agreement and the order is created. Then, on the order lines, when you can

select products and categories that are specified in the sales agreement, the prices and discounts are copied

from that agreement. The same sales order can include both lines that aren't related to a sales agreement and

lines that have a commitment for a sales agreement.

If you've created (released) a sales order against a sales agreement, some fields on that sales order lines can be

modified only if you remove the link to the associated sales agreement lines. The following table lists some of

these fields.

When a customer returns a product that was ordered from a sales agreement, Supply Chain Management can

find and automatically update the related sales agreement commitment to reflect the change in quantity or



Automatic search for sales agreements

Financial dimensions on sales agreements

NOTENOTE

amount. By creating a return order that is based on the original sales order that is linked to a sales agreement,

you establish a relation between the sales agreement commitment, the sales order line, and the return order

invoice.

If you don't want to deduct the returned item quantity from the sales agreement commitment, you can use the

Remove linkRemove link control on the Return orderReturn order  page to remove the link between the return order and the sales

agreement commitment. If you must reestablish the link later, click Create linkCreate link .

Note:Note: A return order can be linked to only one sales agreement. If a customer returns multiple products that

were ordered from multiple sales agreements, you must create a new return order for each product and create a

link to the corresponding sales agreement.

In some situations where sales orders are created indirectly, such as when you create a credit note or

intercompany sales orders, you can control whether the system automatically searches for applicable sales

agreements.

You can copy financial dimensions to either document headers or individual lines of a sales agreement. You can

change the dimensions on an agreement header or agreement line at any time. In this case, the dimensions are

automatically copied to the release header or release line of release orders.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Enter sales agreements
2/18/2021 • 2 minutes to read • Edit Online

Set up sales agreement header

Set up product value commitment lines

This topic explains how to create a sales agreement that commits one of your customers to buy a product for an

agreed amount over time in exchange for special discounts. You can run this procedure in demo data company

USMF or on your own data.

1. In the navigation pane, go to Modules > Sales and marketing > Sales agreements > SalesModules > Sales and marketing > Sales agreements > Sales

agreementsagreements .

2. Select NewNew .

3. In the Customer accountCustomer account field, select the desired record from the drop-down menu.

4. In the Sales agreement classificationSales agreement classification field, select the desired record from the drop-down menu.

5. Expand the GeneralGeneral  section.

6. In the Default commitmentDefault commitment field, select Product value commitmentProduct value commitment. A commitment type is a mandatory

criterion that you must assign to the agreement to define how the agreement contract will be fulfilled. The

four predefined types let you set up the customer's commitment target, expressed as a quantity or a value.

The quantity commitment type can only be applied to a specific product, but the value-based types are

applicable to sales of both specific and non-specific products.

7. In the Expiration dateExpiration date field, set the date to a future date when you want the agreement to expire.

8. Select OKOK.

1. Select Add lineAdd line.

2. In the Item numberItem number  field, select the desired record from the drop-down menu. The type of commitment that

you have chosen for the agreement affects the kind of information you can enter for the agreement lines. For

example, for a value-based agreement you must specify the total net amount (in the agreed currency) for

which the customer commits to buys goods from you. In this example the QuantityQuantity  and UnitUnit fields on the

line are unavailable because you're creating an agreement for the customer to buy a specific value of a

product.

3. In the Net amountNet amount field, enter the monetary amount that the customer has committed to buying.

4. In the Discount percentDiscount percent field, enter a percentage value that will apply to the customer's sales order lines

that are linked to this agreement.

5. Expand the L ine detailsL ine details  section.

6. Select YesYes  in the Max is enforcedMax is enforced field.

7. Expand the Sales agreement headerSales agreement header  section. Unless the status of the agreement is set to EffectiveEffective, sales

orders cannot be associated with the agreement and can therefore not contribute to the fulfilment of that

agreement. You can change the status manually at this stage. However, the status would normally be changed

when you confirm the agreement for the customer.

8. On the Action Pane, select Sales agreementSales agreement.

Selecting Max is enforcedMax is enforced means that the total amount of all the sales order lines that use the

commitment's special prices, discounts and/or payment terms must not exceed the amount specified

on the commitment.

The minimum and maximum release amounts specify a range of values that must be sold on each

sales order that uses the selected agreement.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/tasks/enter-sales-agreements.md
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9. Select ConfirmationConfirmation. Make sure that the Mark agreement as effectiveMark agreement as effective option is set to YesYes .

10. Select YesYes  in the Pr int repor tPr int repor t field.

11. Select OKOK.

12. Close the page. The agreement is now effective. You can start linking the customer's orders to the agreement

to offset against the committed target.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Release a sales order from the agreement

This procedure shows you how to fulfill a sales agreement by associating sales orders with it. You can run this

procedure in demo data company USMF or on your own data. Before starting this guide, make sure you have an

effective sales agreement of type "Product value commitment". Alternatively, you can run the task guide called

"Create sales agreements".

1. Go to Sales and marketing > Sales agreements > Sales agreements.

2. In the list, open the agreement against which you want to release the order.

3. On the Action Pane, click Sales agreement.

4. Click Release order.

5. Click Create.

6. Close the page.

7. Close the page.

8. Go to Sales and marketing > Sales orders > All sales orders.

9. In the list, find and open the order that was created as the result of the order release in the previous task.

10. Click Add line.

11. In the Item number field, click the drop-down button to open the lookup.

12. In the Item number field, type or select the item that is specified on the associated sales agreement.

13. In the Quantity field, enter a number.

14. Click Update line.

15. Click Attached.

16. Close the page.

17. On the Action Pane, click General.

18. Click Attached sales agreement.

19. Expand the Line details section.

20. Click the Fulfillment tab.

As the text on top of the Create release order page points out, the details required for the sales order

lines will differ depending on whether the agreement is quantity- or value-based.

The agreement in this guide is of type "Product value commitment". This is why the Lines section of

this page is blank. If the commitment was based on quantity, the line information would be copied

from the agreement.

The message informs you that a sales order has been created. Since the order does not contain any

lines, you must add order line details to complete the release process.

Make sure that you enter a quantity that brings the Net amount under the value of the associated

sales agreement.

Notice that because the sales order is linked to the agreement, the negotiated discount percent is

applied to the order line.

The Attached agreement page shows the ID and terms of the agreement from which the line is

released.

The Fulfillment tab shows a summary of all the sales order lines that are associated with this

commitment, and their fulfillment state, as well as the amount or quantity that has not yet been

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/tasks/fulfill-sales-agreements.md
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21. Close the page.

22. Close the page.

23. Close the page.

released.

1. Go to Sales and marketing > Sales orders > All sales orders.

2. Click New.

3. In the Customer account field, click the drop-down button to open the lookup.

4. In the list, find and select the customer specified on the sales agreement.

5. In the list, click the link in the selected row.

6. Expand the General section.

7. In the Sales agreement ID field, click the drop-down button to open the lookup.

8. In the list, click the link in the selected row.

9. Click Yes.

10. Click OK.

11. In the list, mark the selected row.

12. In the Item number field, click the drop-down button to open the lookup.

13. In the Item number field, type or select the item that is specified on the associated sales agreement.

14. In the list, click the link in the selected row.

15. Click Save.

16. On the Action Pane, click Pick and pack.

17. Click Post packing slip.

18. Expand the Parameters section.

19. Select Yes in the Posting field.

20. Click OK.

21. Click OK.

22. On the Action Pane, click General.

23. Click Attached sales agreement.

24. Click the Fulfillment tab.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Review a customer rebate agreement

Generate rebate claims

This procedure demonstrates how to process customer rebates from claim generation to the point of passing

them as accruals to Accounts receivable. It walks you through a specific example to explain how the various

conditions on the rebate lines affect the final amounts that will be credited to the customer. You need to use the

USMF demo data company, and carry out the following tasks before you start the guide: (1) Go to the Accounts

receivable parameters page, and expand the Prices tab and then the Price details tab, and check that the Enable

price details option is set to Yes. (2) Go to the Rebate agreements page and select the customer rebate

agreement: USMF-000001. If the Workflow approval status field is not set to Approved, you need click

Validation on the Action Pane to approve it.

1. Go to Navigation pane > Modules > Sales and marketing > Customer rebates > RebateNavigation pane > Modules > Sales and marketing > Customer rebates > Rebate

agreementsagreements .

2. Close the page.

The next few steps look at the conditions of agreement USMF-000001. This makes it easier to

understand how the customer credit values are calculated later in the procedure.

The agreement is for an individual customer, in this example customer US-009.

Rebates are given to the customer when they purchase a specific product. In this case, the product has

item number T0020.

The customer's sales performance, against which the rebate amounts are estimated, is to be

accumulated on a weekly basis.

The setting for "Price taken from" is Gross, which means that line's sales amount on which basis the

claim is estimated is not reduced by the line discount.

The Rebate line break type field shows the method for calculating rebates. In this case, the sales target

against which the rebates are to be estimated is set to Quantity.

The agreement's lines specify the rebate amount type, the actual rebate value, and the thresholds. In

this example, the customer will qualify for a rebate of 20 USD per unit sold, if their weekly purchases

of the product fall within 1 to 50 units; and a rebate of 40 USD per unit sold, if they purchase above 50

units.

1. Go to Navigation pane > Modules > Sales and marketing > Sales orders > All sales ordersNavigation pane > Modules > Sales and marketing > Sales orders > All sales orders .

2. Click NewNew . To mimic the way in which rebate claims would be generated, the next task is to create a sales

order, where the product and quantity will qualify the customer in question for a rebate.

3. In the Customer accountCustomer account field, enter or select a value.

4. Click OKOK.

5. In the Item numberItem number  field, enter or select a value.

6. Set QuantityQuantity  to '40'.

7. Under the Sales order linesSales order lines  section, click Sales order lineSales order line.

8. Click Pr ice detailsPr ice details . If you don't see this option, it's because you didn't set the Enable pr ice details optionEnable pr ice details option

to 'Yes' before you started the guide.

9. Expand the RebatesRebates  section. The RebatesRebates  tab lists all the rebate agreements that are applicable to the

current order line and shows the estimated rebate amount. Note that the displayed amounts are only

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/tasks/process-customer-rebates.md


Process rebate claims

indications of what future rebate claims may be. The actual rebate amounts may be different depending on:

the total sales volume achieved by the customer under a periodic rebate agreement; whether the customer

had returned all or partial quantities; and whether the applicable sales order was invoiced.

10. Close the page.

11. Click Add lineAdd line.

12. In the Item numberItem number  field, enter or select a value.

13. Set QuantityQuantity  to '60'.

14. Click SaveSave.

15. On the Action PaneAction Pane, click InvoiceInvoice.

16. Click InvoiceInvoice.

17. Expand the ParametersParameters  section.

18. In the QuantityQuantity  field, select 'All'.

19. Click OKOK.

20. Click OKOK.

1. Go to Navigation pane > Modules > Sales and marketing > Customer rebates > RebatesNavigation pane > Modules > Sales and marketing > Customer rebates > Rebates .

2. Click CumulateCumulate.

3. In the CustomerCustomer  field, enter or select a value.

4. In the Star t dateStar t date field, select today's date.

5. Click OKOK. As a result of running the CumulateCumulate function, the estimated claim amount has now been adjusted

to account for the fact that the customer's total sales volume in the relevant period is higher than when the

first rebate was generated. More specifically, because the total purchased quantity has reached 100 units, the

customer now qualifies for 40 USD per unit (as per the agreement's second quantity break), or 400 USD of

total rebate amount. The difference is recorded as a new claim "adjustment" for the additional 800 USD. The

status of the rebate claims that were included in the Cumulate update are now set to Calculated.

6. In the list, mark all rows.

7. Click ApproveApprove.

8. Click ProcessProcess .

9. In the CustomerCustomer  field, enter or select a value.

10. Click OKOK. A message shows that the rebate was processed successfully, and the status of the claims has been

changed to Mark. This means that as a result of a Rebate accrual journal being posted:

The Rebates page acts a workbench in which you can review, approve, and process rebate claims.

You'll now process the claims that were created as a result of invoicing a sales order for customer US-

009, who is the subject of the rebate agreement USMF-000001.

The first line represents a rebate claim for 800 USD, which is based on the sales of 40 units of product

T0020, calculated at 20 USD per unit. This matches the conditions of the first quantity break in the

rebate agreement.

The second claim is for 2,400 USD, which is based on the sales of 60 units of product T0020,

calculated at 40 USD per unit, as per the second quantity break in the agreement.

Both claims are in the "To be calculated" state. This means that they are associated with an agreement

that tracks the customer's sales performance on periodic basis and that they have to be re-calculated

to account for the total sales volume within the respective period.

The claims have now been transferred to the temporary customer balance as deductions.

The Rebate accrual account has been credited to represent the future liability towards the customer.

The Rebate expense account has been debited, in recognition of the cost incurred in connection with

the sales.
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Convert rebate claims to credit note

NOTENOTE

This procedure demonstrates how to convert approved and processed customer rebates to credit notes. You can

use this guide in the USMF demo company. The precondition for this guide is to have one or more rebate claims

which have a status of Mark. If you're using USMF you should run the "Generate and process customer rebates"

guide before you start this guide.

1. Go to All customers.

2. In the list, find and select the desired record.

3. In the list, click the link in the selected row.

4. On the Action Pane, click Collect.

5. Click Settle transactions.

6. Click Functions.

7. Click Rebate program.

8. Click Edit.

9. Click Functions.

10. Click Create credit note.

11. Close the page.

12. Click Cancel.

13. On the Action Pane, click Collect.

14. Click Settle transactions.

15. Click Cancel.

The Rebate page lists the rebate claims that you have processed in the customer rebate workbench

and that are in status Mark.

Set checkmarks in the Mark field for the claims that you want to include into credit note.

A message appears to inform you that a journal has been posted (This is the Accounts receivable

consumption journal, as specified in the Accounts receivable parameters page). This causes the real

liability (credit) amount to be moved to the customer balance. This means that the customer's account

has been credited, and the Rebate accrual account has been debited.

This refreshes the page so that you can see the updates.

Note that a transaction for negative amount, representing the total rebate amount, without invoice

reference has been added to the customer balance.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Find the applicable price

Find the applicable discount

This procedure shows how to find the price and/or discount for a product which is currently valid for a specific

customer, without creating a sales order. The procedure walks through a specific example, and you need follow

the example using the USMF demo company in order to select the necessary values.

1. Go to Sales and marketing > Prices and discounts > Find prices.

2. In the Customer account field, click the drop-down button to open the lookup.

3. In the list, find and select customer US-001.

4. In the list, click the link in the selected row.

5. In the Item number field, type 'T0004'.

6. In the Date field, enter a date for when the customer expects to place an order.

7. Click the Show related product variants checkbox.

8. In the list, mark the line representing color White.

9. Click View sales prices.

10. Close the page.

By default, the Quantity field is set to 1. However, if you know the size of the order that the customer

intends to place for the product in question, then enter this value instead. This information is relevant

if the trade agreements with the customer have quantity breaks, that is, the product's price depends

on the minimum quantity purchased.

The date can be today's date or any date in the future.

The system now returns the price that is valid for the selected product when bought by the selected

customer on the selected date with a specified quantity. In this example, if the customer US-001

bought 1 unit of product T0004 today, they would be charged 350 CAD a unit. This price comes from

an existing and active trade agreement with the customer. Other fields on the page provide more

details about the product price and product cost (if set up on the product master), and calculated

profitability.

If the Show related product variants option is selected, it means that there are additional trade

agreements for product's variants.

A list of the product variants is shown, with information about their dimensions.

Notice, that the product price is now different from the one displayed previously when it was not

specified per dimension.

The Price (sales) page displays all the trade agreements applicable to the product, including its

variants.

Make sure the Customer account field contains customer number US-001

1. In the Item number field, type 'T0012'.

2. Set Quantity to '20'.

Make sure the Quantity field is set to 1.

The following pricing details shown for product T0012 come from one or more trade agreements: The

unit price is 1,000 CAD and the discount percentage is 5.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/tasks/look-up-applicable-prices-discounts.md


NOTENOTE

3. Click View line discount.

4. Close the page.

The increased order quantity causes the line discount that will be offered to the customer to change

from 5 to 7 percent.

The Net amount is calculated based on the unit price, discount and the total quantity.

There are two line discount agreements for product T0012, specifying a 5 percent discount for an

order line quantity from 1 to 10, and 7 percent discount for order quantities above 10. Note that the

discounts are applied to a group of products, in this example, Group code 01, of which product T0012

is a member.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Price simulation and discounts

Types of discounts in trade agreementsTypes of discounts in trade agreements

This article provides information about price simulation for quotations. Price simulation helps you to evaluate

the effect of deductions on the future sales price during the quotation process, before you commit to a specific

price.

A price simulation for a quotation shows a new total amount, based on a proposed new price. A price simulation

can also show a new amount for a specific line that is created in an existing quotation. You can enter a price

simulation and apply it later. Alternatively, you can use the original quotation without a price simulation and

make more changes as you work through the sales process with your customer.

A price simulation doesn't change the price in the quotation. If the price simulation is applied to a whole

quotation, it’s treated as a special discount on the quotation header. If the price simulation is applied to specific

items, it’s treated as a special discount on the quotation lines. The unit sales price on a quotation line that is

created doesn't change when a price simulation is applied. Instead, a discount percentage that corresponds to

the price reduction of the quotation line is applied. When a price simulation is applied, the unit sales price and

the discount percentage are transferred to the quotation line or the quotation header.

[Note!] When you run a price simulation, only the current sales currency is used to create the simulation.

However, when you view the quotation totals, you see a combination of the company currency and the sales

currency.

Supplementary items that are added to quotation lines might trigger line discounts or multiline discounts. They

might also trigger total discounts that change the contribution margins and contribution ratios of the quotation

lines and the whole discount.

You can run multiple price simulations to track the effects of price adjustments on the targets of a quotation. By

running these simulations, you can adjust the overall price of the quotation, or the price of one or more specific

lines in the quotation, and then apply the price simulation that is most likely to help you close the sale.

When you create a quotation, you can set up an alert. Here are some of the ways that alerts are used:

They can keep you informed about the status of quotations in the organization.

They can trigger a review of a specific quotation or inform you when discount limits are exceeded.

To guarantee that discounts and prices are calculated correctly, be careful when you run price simulations on

quotations that have discounts. Because all price simulations are treated as special discounts on the active

quotation line or the whole quotation, you must track the differences in the discounts.

Trade agreements in Supply Chain Management can have four types of price discounts. These discounts can be

set up for different items, customers, or price groups, and they can be limited by date. To avoid miscalculations,

you must consider trade agreements when you run price simulations. Here are the four types of discounts in

trade agreements:

Sales pr iceSales pr ice – Separate sales prices can be specified for items. When quotation lines are created, the

program searches for the correct sales price for an item and transfers it to the quotation lines. Therefore, a

trade agreement that has this kind of discount doesn't affect the price simulation. The sales price that is used

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/price-simulation.md


Quotation lines and trade agreementsQuotation lines and trade agreements

Price simulation examples

Price simulation for quotation headersPrice simulation for quotation headers

  C A L C UL AT IO NC A L C UL AT IO N RESULTRESULT

Sales quantity 10 units + 12 units 22 units

Sales value in USD (10 × 15.32) + (12 × 13.75) 318.20

Cost value in USD (10 × 9.52) + (12 × 7.48) 184.96

Contribution margin in USD 318.20 – 184.96 133.24

Contribution ratio ([318.20 – 184.96] ÷ 318.20) × 100 41.87%

  C A L C UL AT IO NC A L C UL AT IO N RESULTRESULT

Sales quantity 10 units + 12 units 22 units

Old sales value in USD (10 × 15.32) + (12 × 13.75) 318.20

Old cost value in USD (10 × 9.52) + (12 × 7.48) 184.96

Old contribution margin in USD 318.20 – 184.96 133.24

in the quotation line reflects the trade agreement.

L ine discountLine discount – Special discounts are specified for items, depending on the quantity that is ordered. Line

amounts are typically reduced by the line discount before a price simulation is run. Therefore, a trade

agreement that has this kind of discount affects the price simulation.

Multiline discountMultiline discount – If the combined quantities exceed the limit that you've defined, predefined

combinations of ordered items trigger a discount on the whole order. Line amounts are typically reduced by

the line discount before a price simulation is run. Therefore, a trade agreement that has this kind of discount

affects the price simulation.

Total discountTotal discount – If the combined amounts exceed the limit that you've defined, predefined ordered items

trigger a discount on the whole order. The total discount is generated by the quotation lines. However,

because the total discount is applied to the quotation total as a discount, it reduces the total amount of the

quotation. Therefore, a trade agreement that has this kind of discount affects the price simulation.

When you create or adjust a quotation line, line discounts are automatically calculated. The relevant sales price is

found for the item, based on the trade agreement.

The following examples use price simulation for quotation headers and single line items.

You create a quotation that has the following lines:

10 units of item BR-12 (cost price per unit: USD 9.52, sales price per unit: USD 15.32)

12 units of item BR-14 (cost price per unit: USD 7.48, sales price per unit: USD 13.75)

The following table shows the quotation lines.

You run a price simulation and apply a 15-percent total discount for the whole quotation, or the quotation

header. The following table shows the new totals of the quotation after the price simulation is run.



Old contribution ratio ([318.20 – (10 × 9.52)] ÷ 318.20) ×
100

41.87%

Price simulation of 15-percent total
discount in USD

(15 × 318.2) ÷ 100 47.73

New sales value in USD 318.20 – 47.73 270.47

New contribution margin in USD 270.47 – 184.96 85.51

New contribution ratio [(270.47 – 184.96) ÷ 270.47] × 100 31.61%

  C A L C UL AT IO NC A L C UL AT IO N RESULTRESULT

Price simulation for single line itemsPrice simulation for single line items

  C A L C UL AT IO NC A L C UL AT IO N RESULTRESULT

Sales quantity 10 units + 12 units 22 units

Sales value in USD for BR-12 10 × 15.32 153.20

Sales value in USD for BR-14 12 × 13.75 165.00

Cost value in USD for BR-12 10 × 9.52 95.20

Cost value in USD for BR-14 12 × 7.48 89.76

Contribution margin in USD for BR-12 153.20 – 95.20 58.00

Contribution margin in USD for BR-14 165.00 – 89.76 75.24

Contribution ratio in USD for BR-12 [(153.20 – 95.20) ÷ 153.20] × 100 37.86

Contribution ratio in USD for BR-14 [(165.00 – 89.76) ÷ 165.00] × 100 45.60

Total sales value in USD (10 × 15.32) + (12 × 13.75) 318.20

Total cost value in USD (10 × 9.52) + (12 × 7.48) 184.96

Total contribution margin in USD 318.20 – 184.96 133.24

Total contribution ratio [(318.20 – 184.96) ÷ 318.20] × 100 41.87%

You create a quotation that has the following lines:

10 units of item BR-12 (cost price per unit: USD 9.52, sales price per unit: USD 15.32)

12 units of item BR-14 (cost price per unit: USD 7.48, sales price per unit: USD 13.75)

The following table shows the quotation lines.

You run a price simulation and apply a 10-percent total discount to the BR-12 units. The following table shows

the new totals of the quotation after the price simulation is run for the single line item.



  C A L C UL AT IO NC A L C UL AT IO N RESULTRESULT

Sales quantity 10 units + 12 units 22 units

Old sales value in USD for BR-12 10 × 15.32 153.20

Price simulation of 10-percent
discount for BR-12

(10 × 153.2) ÷ 100 15.32

New sales value in USD for BR-12 (10 × 15.32) – 15.32 137.88

Sales value in USD for BR-14 12 × 13.75 165.00

Cost value in USD for BR-12 10 × 9.52 95.20

Cost value in USD for BR-14 12 × 7.48 89.76

New contribution margin in USD for
BR-12

137.88 – 95.20 42.68

Contribution margin in USD for BR-14 165.00 – 89.76 75.24

New contribution ratio in USD for BR-
12

[(137.88 – 95.20) ÷ 137.88] × 100 30.95

Contribution ratio in USD for BR-14 [(165.00 – 89.76) ÷ 165.00] × 100 45.60

New total sales value in USD [(10 × 15.32) – 15.32] + (12 × 13.75) 302.88

Total cost value in USD (10 × 9.52) + (12 × 7.48) 184.96

New total contribution margin in USD 302.88 – 184.96 117.92

New total contribution ratio [(302.88 – 184.96) ÷ 302.88] × 100 38.93%

NOTENOTE

The price simulation affects only the line that it's applied to and reduces the total for that line.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Mass create sales quotations
2/18/2021 • 2 minutes to read • Edit Online

Create a quotation template

This procedure demonstrates how to efficiently create quotations offering a set of products or services that are

to be sent to multiple customers. This mass quotation creation is based on quotation templates. You can run this

procedure on your own data or in demo data company USMF.

1. Go to Sales and marketing > Setup > Quotations > Template groups.

2. Click New.

3. In the Group ID field, type an ID of your choice.

4. In the Description field, type a value.

5. Click Save.

6. Close the page.

7. Go to Sales and marketing > Sales quotations > All quotations.

8. Click New.

9. In the Account type field, select 'Customer'.

10. In the Customer account field, enter or select a value.

11. Click OK.

12. On the Action Pane, click Options.

13. Click Change view.

14. Click Header view.

15. Expand the Setup section.

16. In the Group ID field, enter or select a value.

17. In the Template name field, type a value.

18. Select Yes in the Active field.

19. On the Action Pane, click Options.

20. Click Change view.

21. Click Line view.

22. In the Item field, enter or select a value.

23. In the Item field, type a value.

24. Close the page.

25. In the Discount percent field, enter a number.

26. Click Add line.

27. In the Item field, enter or select a value.

28. In the Item field, type a value.

29. Close the page.

30. In the Unit price field, enter a new price or change the current one.

31. Click Add line.

32. In the Item field, enter or select a value.

33. In the Item field, type a value.

For a quotation to become a template you must carry out setup steps on the quotation header. This

must be done before you add lines to the quotation.

Only active templates can be used when you apply a template to a new sales quotation.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/tasks/mass-sales-quotations.md


Apply the template to create a single quotation

Apply the template to mass create quotations

NOTENOTE

34. Close the page.

35. In the Quantity field, enter a number.

36. In the Discount field, enter a number.

37. Click Save.

1. Go to Sales and marketing > Sales quotations > All quotations.

2. Click New.

3. In the Account type field, select 'Customer'.

4. In the Customer account field, enter or select a value.

5. Expand the Template section.

6. In the Group ID field, enter or select a value.

7. In the Template name field, enter or select a value.

8. In the Calculation method field, select 'Based on template values'.

9. Click OK.

10. Close the page.

11. Close the page.

Note that the quotation you have just created is marked as template.

The new quotation has now been created, based on the data and terms of the template.

1. Go to Sales and marketing > Sales quotations > Quotation update > Mass create quotations.

2. In the Account type field, select 'Customer'.

3. In the Group ID field, enter or select a value.

4. In the Template name field, enter or select a value.

5. In the Calculation method field, select 'Based on template values'.

6. Expand the Records to include section.

7. Click Filter.

8. In the Criteria field, set the filter to cover a range of customers you want to include in this mass quotation

creation. Use the following format "Customer1..CustomerN.

9. Click OK.

10. Click OK.

11. Go to Sales and marketing > Sales quotations > All quotations.

For example, you could set the filter to: US-001..US-004

Verify that quotations have been created for all the customers specified in the mass update routine, as

based on the selected template.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create and edit sales quotations
2/18/2021 • 3 minutes to read • Edit Online

Create a sales quotation

This procedure demonstrates how to create and update a sales quotation. You can run this procedure on your

own data or in demo data company USMF.

1. Go to Navigation pane > Modules > Sales and marketing > Sales quotations > All quotationsNavigation pane > Modules > Sales and marketing > Sales quotations > All quotations .

2. Click NewNew .

3. In the Account typeAccount type field, select 'Prospect'.

4. In the ProspectProspect field, enter or select a value.

5. Expand the GeneralGeneral  section. Because you chose to create a quotation from the Sales and Marketing area, the

type is automatically set to 'Sales quotation'. To create a quotation for a project you must access it from the

Project management and accountingProject management and accounting module.

6. Click OKOK. The fields and actions on the quotation lines are very similar to the ones on the sales order lines.

Like sales orders, quotations can be created for a specific item or, when item number is not known or does

not exist at the time of quotation creation, quotations can be created for a sales category.

7. In the ItemItem field, enter or select a value.

8. In the S iteSite field, type a value.

9. In the QuantityQuantity  field, enter a number. If there are valid trade agreements for the item selected on the line, the

applicable price and discounts will be automatically copied to the quotation line. Make sure that the Unit

price field contains a value and you can also enter discount values if you want to.

10. Click SaveSave.

11. On the Action PaneAction Pane, click Sales quotationSales quotation.

12. Click TotalsTotals .

13. Click OKOK.

14. Select the sales quotation line.

15. On the Action PaneAction Pane, click QuotationQuotation.

16. Click Pr ice simulationPrice simulation.

17. On the Action PaneAction Pane, click QuotationQuotation.

18. Click Send quotationSend quotation.

In the Run price simulationRun price simulation page you can experiment with adjusting the expected revenue or

profitability of your quotation based on the desired unit price, discount amount, discount percentage,

total amount, margin, or contribution ratio. When you are satisfied with the target figures, you apply

the suggestion to the quotation line, and its price-related fields will be updated accordingly.

You can create as many price simulations as you wish. When you click NewNew , the price conditions from

the current quotation line are copied to the page. You can then modify values in any of the price-

related fields to the target ones. A change in one of the fields will trigger recalculation in all the other

fields. In order for the system to calculate the sales margin and contribution ratio, the product's unit

cost has to be known. Use the Simulated prices tab for a detailed view of the original prices, proposed

changes and their effect on the quotation totals. As a general rule, when a simulation that sets a new

amount is applied to the quotation line, the system recalculates and enters a new value in the Unit

price field. If the simulation is based on a new margin or a new contribution ratio, only the Net

amount field is updated, and the Unit price is blank. In both cases, any discounts that were on the

quotation line before simulation will be deleted.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/tasks/create-edit-sales-quotations.md


Update a sales quotation

NOTENOTE

19. Select 'Yes' in the Pr int quotationPrint quotation field.

20. Click OKOK. The report may take a minute to generate. Don't close the page until it does so.

1. Go to Navigation pane > Modules > Sales and marketing > Sales quotations > All quotationsNavigation pane > Modules > Sales and marketing > Sales quotations > All quotations .

2. On the Action PaneAction Pane, click Follow upFollow up.

3. Click Conver t to customerConver t to customer .

4. In the Customer accountCustomer account field, type a value.

5. Click CheckCheck . Make sure you see a message that the account number you typed in is free to use.

6. Click OKOK. The system has now created a new customer account for the prospect on the quotation.

7. Close the page.

8. On the Action PaneAction Pane, click Follow upFollow up.

9. Click ConfirmConfirm .

10. In the ReasonReason field, enter or select a value.

11. Click OKOK.

12. On the Action PaneAction Pane, click GeneralGeneral .

13. Click Sales ordersSales orders .

14. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Troubleshoot sales quotations
2/18/2021 • 2 minutes to read • Edit Online

I can't change the sales quantity of a sales quotation for a service
item.
Issue descriptionIssue description

Issue resolutionIssue resolution

NOTENOTE

This topic describes how to fix issues that you might encounter while you work with sales quotations.

If you try to set a sales quantity (SalesQtySalesQty  field) for an item of the Service type on a sales quotation line, you

will receive the following message: "Update not allowed for field Quantity."

You can't set a sales quantity for products that are service items. For example, if you offer a service to install an

item, it doesn't make sense to record a quantity, because there is no physical item. There is only a service.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/troubleshooting-salesquotation.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Sales returns
2/18/2021 • 23 minutes to read • Edit Online

Return order process

Physical return order processPhysical return order process

Credit only processCredit only process

This topic provides information about the process for return orders. It includes information about customer

returns and their effect on costing and on-hand inventory quantities.

Customers can return items for various reasons. For example, an item might be defective, or it might not meet

the customer's expectations. The return process starts when a customer issues a request to return an item. After

the customer's request is received, a return order is created.

The following illustration gives an overview of the return order process.

There are two types of return order process: physical return and credit only.

Physical returnPhysical return – The return order authorizes the physical return of products.

Credit onlyCredit only  – The return order authorizes a customer credit but doesn't require that the customer physically

return the products.

1. Create a return order.Create a return order. Formally document the authorization for the customer to return any defective or

unwanted products. The return order doesn’t require that the company accept the returned products or

provide a credit for the customer. If the return is accepted, you can authorize a replacement item to be sent

before the defective item has been returned.

2. Arr ive at warehouse for inspection.Arr ive at warehouse for inspection. Complete an initial inspection and validation against the return

order document. The return order also supports quarantine of the returned items for additional inspection

and quality control.

3. Determine disposition.Determine disposition. Finalize the inspection process, and decide what should be done with the returned

products. As part of this step, decide whether you will credit the customer, reject the product return, or accept

the product return, scrap the product, and then send a replacement product to the customer.

4. Generate a packing slip.Generate a packing slip. Generate a packing slip, and commit the disposition decision that you made in

step 3. Finalize the logistics processes.

5. Generate an invoice.Generate an invoice. Close the return order.

1. Create a return order.Create a return order. Formally document the authorization for the customer to receive a credit without

returning the defective or unwanted products. The Credit onlyCredit only  disposition code authorizes the decision to

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/sales-returns.md
file:///T:/eiye/ac1a/dynamics365/supply-chain/warehousing/media/salesreturns01.jpg


Return material authorization

Create a return order

Create a return order headerCreate a return order header

credit the customer without physical return.

2. Generate an invoice.Generate an invoice. Generate the credit note, and then close the return order.

Return Material Authorization (RMA) processing builds on sales order functionality. An RMA is registered as a

return order, which is created as a sales order, and may have another sales order associated with it, called a

replacement order. Both sales orders link to the originating RMA number.

Return orderReturn order  – To register an RMA, you create a return order, which is a sales order that has the assigned

type, Returned order.Returned order. Any changes that you make to the RMA information is automatically updated in the

sales order. Until the return order has the status OpenOpen, it will not appear in the list of sales orders. You use

RMA to handle the arrival and receipt of the returned items, as well as to authorize a credit only disposition

action (see section Disposition codes and disposition actionsDisposition codes and disposition actions ). All other follow-up processes must be

handled in the sales order.

Replacement orderReplacement order  – When a replacement order must be shipped to the customer, the RMA can include a

second associated sales order. You can manually create the replacement order for the RMA to support

immediate shipment. Alternatively, the replacement order can be created automatically after the arrival,

inspection, and receipt are completed for the RMA line item that has a disposition code that indicates

replacement. The replacement order has the same functionality that is associated with a sales order. For

example, you can use it to configure a custom product as the replacement item, create a production order to

repair a returned item, create a direct delivery purchase order to send the replacement from a vendor, or

support other purposes.

The return order process starts when a customer contacts your organization to return a defective or unwanted

product and/or to be credited. After your organization accepts the return, the return is documented by a return

order. This return order becomes the focal point of the internal processing of the returned product. The

following illustration shows the procedure for creating a return order.

When you create a return order, the information in the following table must be included.

file:///T:/eiye/ac1a/dynamics365/supply-chain/warehousing/media/salesreturn02.png


F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N C O M M EN T SC O M M EN T S

Customer account A reference to the Customers table You must provide an existing customer
account.

Delivery address The address that the item is returned
to

By default, the organization’s address
is used. If a specific warehouse is
selected on the header, the delivery
address is changed to the delivery
address of the warehouse. You can
change this address on the ReturnReturn
order detailsorder details  page.

Site/warehouse The site or warehouse that receives the
returned product

The delivery address for the return
order is determined based on the
delivery address of the site or
warehouse.

RMA number The ID that is assigned to the return
order

The RMA number is used as an
alternate key throughout the return
order process. The RMA number that
is assigned is based on the RMA
number sequence that is set up on the
Accounts receivable parametersAccounts receivable parameters
page.

Deadline The last date that an item can be
returned

The default value is calculated as the
current date plus the period of validity.
For example, if a return is valid for only
90 days from date when the return
order is created, and the return order
was created on May 1, the value in the
field is 30-July30-July . The period of validity
is set on the Accounts receivableAccounts receivable
parametersparameters  page.

Return reason code The customer’s reason for returning
the product

The reason code is selected in the list
of user-defined reason codes. You can
update this field at any time.

Create return order linesCreate return order lines

ChargesCharges

After you complete the return header, you can create return lines by using one of the following methods:

Manually enter the item details, quantity, and other information for every return line.

Create a return line by using the Find sales orderFind sales order  function. We recommend that you use this function when

you create a return order. The Find sales orderFind sales order  function establishes a reference from the return line to the

invoiced sales order line, and retrieves line details such as item number, quantity, price, discount, and cost

values from the sales line. The reference helps guarantee that, when the product is returned to the company,

it's valued at the same unit cost that it was sold at. The reference also validates that return orders aren't

created for a quantity that exceeds the quantity that was sold on the invoice.

[Note!] Return lines that have a reference to a sales order are handled as corrections to, or reversals of, the

sale. For more information, see the "Post to the ledger" section, later in this topic.

Fees and charges can be added to the return order through one or more of the following methods:



Return reason codesReturn reason codes

Disposition codes and disposition actionsDisposition codes and disposition actions

DISP O SIT IO N  C O DEDISP O SIT IO N  C O DE F IN A N C IA L  IM P L IC AT IO N SF IN A N C IA L  IM P L IC AT IO N S IM P L IC AT IO N S F O R LO GIST IC SIM P L IC AT IO N S F O R LO GIST IC S

Credit only The item should not be returned. This
disposition action is used for the
following cases:

Credit The item is returned and is added back
into inventory.

You can manually add charges to the return order header, the return order line, or both.

Charges can be automatically added to the return order header as a function of the return reason code.

Charges can be automatically added to the return order line, based on the disposition code of the line.

Charges are automatically added after a return reason code or disposition code is assigned to the line. If the

reason code is changed later, the existing charge entry won't be removed, but a new charge entry might be

added, based on the new reason code. When you add charges to return order lines, charges that are calculated

as a percentage of the line or order value become negative when the line or line order is negative, unless the

percentage is also a negative number. A charge that has a negative value represents a credit to the customer.

By applying reason codes to returns, you can help make return patterns easier to analyze. Reason codes provide

information about why a customer wants to return items. Some organizations have many reason codes. These

organization might group the reason codes into reason code groups to gain a better overview and for

accumulated reporting.

An important step in the return order process is the assignment of a disposition code to the return order line as

part of arrival registration. The disposition code determines the following information:

The financial implicationsThe financial implications  – Should the customer be credited for the returned items, and should any

charges be added to the return order line?

The disposition of the returned itemThe disposition of the returned item – Should the item can be added back to inventory, should it be

scrapped, or should it be returned to the customer?

The logistics of the returned itemThe logistics of the returned item – Should a replacement item be issued to the customer?

In addition to determining how the returned goods are disposed of, disposition codes can cause charges to be

applied to the return line. They can also be used to group returns for statistical analysis. Disposition codes are

defined as part of the setup of return orders. However, each disposition code must reference one of the built-in

disposition actions. The following table lists the built-in disposition codes and their actions. Impor tant:Impor tant: If an

item should not be returned, but the customer should still be credited, assign the Credit onlyCredit only  disposition code

to the return line.

The customer is credited the
sales price minus any fees or
charges.

Loss from scrapping the item is
posted to the ledger.

There is sufficient trust among
the parties.

The cost of returning the
defective item is prohibitive.

The items can't be allowed back
into inventory. Because of
other conditions, a physical
return isn't required.

The customer is credited the
sales price minus any fees or
charges.

The inventory value is
increased by the cost of the
returned item.



Replace and credit The item is returned and is added back
into inventory.

Replace and scrap The item is returned and scrapped.

Return to customer None, except any fees or charges. The item is returned but is sent back
to the customer after inspection. This
disposition action might be used if the
item has been deliberately damaged,
or if the warranty has been voided.

Scrap The item is returned or scrapped.

DISP O SIT IO N  C O DEDISP O SIT IO N  C O DE F IN A N C IA L  IM P L IC AT IO N SF IN A N C IA L  IM P L IC AT IO N S IM P L IC AT IO N S F O R LO GIST IC SIM P L IC AT IO N S F O R LO GIST IC S

Arrival at the warehouse for inspection

The customer is credited the
sales price minus any fees or
charges.

Inventory value is increased by
the cost of the returned item.

A separate sales order for a
replacement is created and is
handled separately.

Customer is credited the sales
price, less any fees or charges.

Loss from scrapping the item is
posted to the ledger.

A separate sales order for a
replacement is created and is
handled separately.

The customer is credited the
sales price minus any fees or
charges.

Loss from scrapping the item is
posted to the ledger.

Before you can physically receive returned items into inventory by posting a packing slip, the items must go

through arrival registration and an optional inspection. The following illustration gives an overview of the arrival

process. The sections that follow describe each step that is shown in the illustration.



Identify products in the Arrival overview listIdentify products in the Arrival overview list

Edit the Arrival journalEdit the Arrival journal

The process has several other variations that aren't covered in this topic. Here are some of these variations:

Don't use the Arr ival over viewArr ival over view  list to create an Arrival journal. Instead, manually create the Arrival journal.

Return orders will have Sales orderSales order  as the reference.

If you're using Warehouse management, generate pallet transports. The return line will have a status of

Arr ivedArr ived during pallet transport.

Register the arrival of the returned item directly from the return order line, by using the RegistrationRegistration

function.

During the arrival process, returns are integrated with the general process for warehouse arrivals. The arrival

process also supports the creation of quarantine orders for returned items that must undergo a separate

inspection.

The Arr ival over viewArr ival over view  page lists all the planned incoming arrivals.

[Note!] Arrivals from return orders must be processed separately from other types of arrival transactions.

After you've identified an incoming package on the Arr ival over viewArr ival over view  page (for example, by using the

accompanying RMA document), on the Action Pane, click Star t arr ivalStar t arr ival  to create and initialize an Arrival

journal that matches the arrival.

By setting the Quarantine managementQuarantine management option to YesYes , you can create a quarantine order for the return line. If

a line has been sent to quarantine for inspection, you can’t specify a disposition code.

If you set the Quarantine managementQuarantine management option to YesYes  in the item’s inventory model group, the QuarantineQuarantine

managementmanagement option on the Journal linesJournal lines  page will be marked for the Arrival journal line and can’t be

changed. If the line is sent to quarantine, you must specify the appropriate quarantine warehouse.

If the arrival line isn't sent for inspection, the warehouse arrival clerk must specify the disposition code directly

on the Arrival journal line and then post the Arrival journal. If the same disposition code should not be assigned

to the whole quantity of the return line, or if the full quantity of the line hasn't been received, you must split the

line. When you split an Arrival journal line, you also split the return line (SalesLineSalesLine) and create a new lot ID. You

can split the line by reducing the quantity of the Arrival journal line. When the journal is posted, a new return

line is created that has a status of ExpectedExpected for the remaining quantity. You can also split the line by clicking

file:///T:/eiye/ac1a/dynamics365/supply-chain/warehousing/media/salesreturn03.png


Process the quarantine orderProcess the quarantine order

Replace a product

Up-front replacementUp-front replacement

FunctionsFunctions  > SplitSplit.

If the returned products are sent for inspection at the quarantine warehouse, any additional processing is

completed in a quarantine order. One quarantine order is created for each arrival line that is sent to quarantine.

The disposition code indicates the result of the inspection process.

You can split a quarantine order, just as you can split the Arrival journal. If you split the quarantine order, you

cause a corresponding split of the return line. After the disposition code is entered, complete the quarantine

order by using either the EndEnd function or the Repor t as finishedRepor t as finished function. If you select Repor t as finishedRepor t as finished, a

new arrival is created in the designated warehouse. You can then process this arrival by using the Arr ivalArr ival

over viewover view  page.

If the arrival originates from a quarantine order, you can't change the disposition code that is assigned during

inspection. If you complete the quarantine order by using the EndEnd function, the lot is automatically registered.

Sometimes, an item might be sent back from quarantine to the Shipping and receiving department. For

example, the quarantine inspector might not know where to store the item in inventory. In this case, the

corresponding packing slip must be updated to correctly register and act on the disposition code that is

specified because of the quarantine.

Acknowledgment of receipt can be sent to the customer when the return line is registered. The ReturnReturn

acknowledgementacknowledgement report resembles the return order document. The Return acknowledgementReturn acknowledgement report isn't

journalized or otherwise registered in the system, and it isn't a required step in the return order process.

There are two methods for managing product replacement:

Up-front replacementUp-front replacement – Replace a product before the returned product is received from the customer.

Replacement by disposition codeReplacement by disposition code – Automatically create a new replacement order line.

In up-front replacement, the replacement item can be delivered to the customer before the item is returned. This

method is useful if, for example, the item is a machine part that can’t be removed unless a spare part is available

to take its place, or if you just want your customer to have the replacement product as soon as possible. The up-

front replacement order is an independent sales order. The header information is initialized from the customer,

and the line information is initialized from the return order. You can edit, process, and delete the replacement

order independently of the return order. When you delete a replacement order, you receive a message that the

order was created as a replacement order. The following illustration shows the process for up-front replacement.



Replacement by disposition codeReplacement by disposition code

The return order includes a reference to the replacement order. If an up-front replacement order is created for a

return order before the defective item is returned, you can't select disposition codes for replacement after the

defective item has been returned.

If you ship a replacement item to the customer, and you use the Replace and scrapReplace and scrap or Replace and creditReplace and credit

disposition action on the return order, use the process that is shown in the following illustration.

The replacement item will be delivered by using an independent sales order, the replacement sales order. This

sales order is created when the packing slip for the return order is generated. The order header uses information

from the customer that is referenced on the return order header. The line information is collected from the

information that is entered on the Replacement itemReplacement item page. The Replacement itemReplacement item page must be filled in for

lines that have disposition actions that start with the word "replace." However, neither the quantity nor the

identity of the replacement item is validated or limited. This behavior allows for cases where the customer wants

the same item but in a different configuration or size, and also cases where the customers wants a completely



Generate a packing slip

Generate an invoice

Credit correctionCredit correction

different item. By default, an identical item is entered on the Replacement itemReplacement item page. However, you can select

a different item, provided that the function has been set up.

[Note!] You can edit and delete the replacement sales order after it's created.

Before returned items can be received into inventory, you must update the packing slip for the order that the

items belong to. Just as the invoice update process is the update of the financial transaction, the packing slip

update process is the physical update of the inventory record. In other words, this process commits the changes

to inventory. In the case of returns, the steps that are assigned to the disposition action are implemented during

the packing slip update. When you generate the packing slip, the following events occur :

In the warehouse, the standard process is used to perform a physical receipt. Ledger postings are generated

if the inventory model group (Post physical inventor yPost physical inventor y ) and the Accounts receivable parameters (PostPost

packing slip in ledgerpacking slip in ledger ) are set appropriately.

Items that have been marked with a disposition action that contains the word "scrap" are scrapped, and the

inventory loss is posted to the ledger.

Items that have been marked with the Return to customerReturn to customer  disposition action are received and delivered to

the customer. These items have no net effect on inventory.

A replacement sales order is created. This sales order is based on information on the Replacement itemReplacement item

page.

You can generate the packing slip only for lines that have a return status of RegisteredRegistered, and only for the full

quantity on the return line. If several lines on the return order have the RegisteredRegistered status, you can generate the

packing slip for a subset of the lines by deleting the other lines from the Post packing slipPost packing slip page.

Partial returns are defined in terms of return order lines, not in terms of return order shipments. Therefore, if

you receive the full quantity that is indicated on one return order line, but you receive nothing from the other

lines on the return order, the delivery isn't a partial delivery. However, if a return order line requires that 10 units

of an item be returned, but you receive only four units, the delivery is a partial delivery. If not all the expected

return items have arrived, you can set the shipment aside and wait for the rest of the returned quantity to arrive.

Alternatively, you can register and post the partial quantity. As part of the process for posting packing slips, you

can associate the packing slip reference number from the customer’s shipping documents with the order lines.

This association is optional and is for reference only. It doesn't create any transactional updates.

In general, you can skip the packing slip process and go directly to invoicing. In this case, the steps that you

would have performed during packing slip generation are completed during invoicing.

Although the Return orderReturn order  page contains the information and actions that are required in order to handle the

special logistical aspects of the return order, you must use the Sales orderSales order  page to complete the invoicing

process. Your organization can then invoice return orders and sales orders at the same time, and the same

person can complete the invoicing process, as required. To view the return order from the Sales orderSales order  page,

click the link for the sales order number to open the associated sales order. You can also find the return order on

the All Sales ordersAll Sales orders  page. Return orders are sales orders that have an order type of Returned orderReturned order .

As part of the invoicing process, verify that any miscellaneous charges are correct. To cause the ledger postings

to become corrections (Storno), consider using the Credit correctionCredit correction option on the OtherOther  tab of the PostingPosting

invoiceinvoice page when you post the invoice/credit note.

[Note!] By default, the Credit correctionCredit correction option is activated if the Credit note as correctionCredit note as correction option on



Create intercompany return orders

SetupSetup

Simple intercompany returnsSimple intercompany returns

the Accounts receivable parametersAccounts receivable parameters  page has been enabled. However, we recommend that you not post

returns with Storno.

Return orders can be completed between two companies within your organization. The following scenarios are

supported:

Simple intercompany returns between two companies that participate in an intercompany relation

An intercompany chain that is established when a customer return order is created in the selling company

An intercompany chain that is established when a vendor return order is created in the buying company

Direct delivery shipment returns between an external customer and two companies that participate in an

intercompany relation

The following illustration the minimum setup that is required for two companies to participate in an

intercompany relation and take advantage of intercompany trade.

In the following scenario, CompBuy is the buying company, and CompSell is the selling company. Usually, the

selling company ships goods either to the buying company or, in direct delivery shipment scenarios, directly to

the end customer. In CompBuy, the vendor IC_CompSell is defined as an intercompany endpoint that is

associated with the company CompSell. At the same time, in CompSell, the customer IC_CompBuy is defined as

an intercompany endpoint that is associated with the company CompBuy. The appropriate action policy details

and value mappings must be defined in both companies. In a direct delivery shipment scenario, an

intercompany return order, which is also an intercompany sales order, is created in the selling company. The

RMA number of the intercompany return order can be picked from the RMA number sequence in CompSell, or

it can be copied from the RMA number that is assigned to the original return order in CompBuy. The RMA

number settings on the PurchaseRequisitionPurchaseRequisition action policy in CompBuy determine these actions. If the RMA

number is synchronized, you should plan to mitigate the risk of number clashes if the two companies use the

same number sequence.

This scenario involves two companies in the same organization, as shown in the following illustration.



Direct delivery shipment returns among three partiesDirect delivery shipment returns among three parties

Post to the ledger

The order chain can be established when a vendor return order is created in the buying company or a customer

return order is created in the selling company. The corresponding order is created in the other company and

makes sure that the header and line information on the vendor return order reflects the settings on the

customer return order. The return order that is established can either include or exclude the reference (FindFind

sales ordersales order ) to an existing customer invoice. The packing slips and invoices of the two orders can be processed

individually. For example, you don't have to generate a packing slip for the vendor return order before you

generate the packing slip for the customer return order.

This scenario can be established if a previous sale of the Direct deliver yDirect deliver y  type has been completed, and if an

invoice against the customer exists in the company that interacts with the customer. In the following illustration,

the company CompBuy has previously sold and invoiced products to the customer Extern. The products were

shipped directly from the company CompSell to the customer via an intercompany order chain.

If the customer Extern wants to return the products, a return order (RMA02) is created for the customer in the

company CompBuy. To establish the intercompany chain, the return order must be marked for direct delivery.

When you use the Find sales orderFind sales order  function to pick the customer invoice to return, an intercompany order

chain that consists of the following documents is established:

Original return order :Original return order : RMA02 (company CompBuy)

Purchase order :Purchase order : PO02 (company CompBuy)

Intercompany return order :Intercompany return order : RMA_00032 (company CompSell)

After the direct delivery intercompany chain is created, all physical handling and processing of the returns must

occur in context of the intercompany return order, RMA_00032 in the company CompSell. The products can't be

received in the company CompBuy. When a disposition code is assigned to the intercompany return order, it's

synchronized with the original return order to allow for proper invoicing of the original order.

The ledger postings that are generated when the return order is invoiced are influenced by a few important

settings and parameters:

Return cost pr iceReturn cost pr ice – For inventory models other than Standard costStandard cost, the Return cost pr iceReturn cost pr ice parameter



Example 1: The return order doesn't reference a customer invoiceExample 1: The return order doesn't reference a customer invoice

Example 2: Credit correction is selected for the return orderExample 2: Credit correction is selected for the return order

Example 3: The return order line is created by using the Find sales order functionExample 3: The return order line is created by using the Find sales order function

determines the cost of the item when it's accepted back into inventory or scrapped. To calculate a correct

valuation of inventory, it's important that you set the Return cost pr iceReturn cost pr ice parameter correctly. If you use the

Find sales orderFind sales order  function to create a return order line that has a reference to a customer invoice, the

Return cost pr iceReturn cost pr ice value is equal to the cost price of the item that is sold. Otherwise, the cost price value

comes from the item setup or can be entered manually.

Credit correction/StornoCredit correction/Storno – The Credit correctionCredit correction parameter on the Posting invoicePosting invoice page determines

whether postings should be recorded as positive (DR/CR) entries or as correcting, negative entries.

In the examples that follow, the return cost price is represented as Inv. Cost pr iceInv. Cost pr ice.

The return order doesn't reference a customer invoice. The returned item is credited. The Credit correctionCredit correction

parameter isn't selected when the return order invoice, or credit note, is generated.

[Note!] The item master price is used as the default value for the Return cost pr iceReturn cost pr ice parameter. The default

price differs from the cost price at the time of inventory issue. Therefore, the implication is that a loss of 3

has been incurred. Additionally, the return order doesn't include the discount that was given to the customer

on the sales order. Therefore, an excessive credit occurs.

Example 2 is the same as example 1, but the Credit correctionCredit correction parameter is selected when the return order

invoice is generated.

[Note!] The ledger postings are entered as negative corrections.

In this example, the return order line is created by using the Find sales orderFind sales order  function. The Credit correctionCredit correction

parameter isn't selected when the invoice is created.

[Note!] DiscountDiscount and Return cost pr iceReturn cost pr ice are set correctly. Therefore, an exact reversal of the customer

invoice occurs.
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Invoice a sales order that qualifies a salesperson for a commission

This topic explains how sales commissions are calculated and registered. You can run this procedure in demo

data company USMF or on your own data. Before starting this guide, run the guide called "Set up sales

commission rules" to make sure that you have all the necessary commission calculation setup.

Take note of the customer and item numbers that you have chosen for the commission process and use them

when asked to create a sales order in this guide.

1. In the navigation pane, go to Modules > Sales and marketing > Sales orders > All sales ordersModules > Sales and marketing > Sales orders > All sales orders .

2. Select NewNew .

3. In the Customer accountCustomer account field, select the desired record from the drop-down menu.

4. Select OKOK.

5. On the Action Pane, select OptionsOptions .

6. Select Change viewChange view .

7. Select Header viewHeader view .

8. Expand the SetupSetup section.

The value in the Sales groupSales group field represents a group with one or more sales representatives

assigned to it. The people in the group are the ones who will receive commissions when the order is

invoiced, as per predefined rates and distribution.

The value is copied from the Customer card, but you can change it if you wish.

The Sales group is also copied to the sales order line. You can change it so that it can differ from the

one in the header and/or between lines.

The value in the Commission groupCommission group field represents a group that you have created for one or more

customers with the purpose of tracking commissions.

The value is copied from the Customer card, but you can change it if you wish.

9. On the Action Pane, select OptionsOptions .

10. Select Change viewChange view .

11. Select L ine viewLine view .

12. In the drop down menu of the Item numberItem number  field, select the item you have set up for commissions.

13. In the QuantityQuantity  field, enter a number. Take note of the line's Net amount. It represents the sales revenue,

which in this example is the basis for commission calculation.

14. Select SaveSave.

15. On the Action Pane, select InvoiceInvoice.

16. Select InvoiceInvoice.

17. Expand the ParametersParameters  section.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/tasks/register-sales-commissions.md


Review the registered sales commissions
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18. In the QuantityQuantity  field, select AllAll .

19. Select YesYes  in the PostingPosting field.

20. Select OKOK, then select OKOK in the next pane. It may take a minute or so to post the transaction. Allow the

processing to complete and don't close the page.

1. On the Action Pane, select InvoiceInvoice, then select InvoiceInvoice again.

2. On the Action Pane, select InvoiceInvoice, then select Commission transactionsCommission transactions .

The Over viewOver view  tab displays lines representing the commission amounts payable to sales

representatives who are associated with the invoiced sales order. Let's review the details.

If you used the "Set up sales commission rules" guide to set up the Commission salesCommission sales  group, there

are two sales people to receive a sales commissions, and the commission is split equally between

them.

In this example, the total amount of the commission is calculated as a percentage of the sales revenue

(the net amount of order line).

3. Close the page.

4. Select VoucherVoucher . You can review the voucher transactions for the commission amounts that have been

posted to the predefined commission expense and commission payable accounts.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Set up commission groups and commission rates

This procedure shows you how to set up and enable sales commission calculation and tracking. The procedure

shows how to create both customer and item commission groups, and then how to link a selected customer and

product to the respective groups. Those groups are then used in the commission calculation setup to create a

customer, item, and sales representatives combination that must be matched by the sales order to entitle the

sales people to a commission. Creating customer and item commission groups are optional, as the calculation of

commission can also be done for an individual customer and/or item. You can run this procedure in demo data

company USMF or on your own data.

1. Go to Navigation pane > Modules > Sales and marketing > Commissions > Customer groupsNavigation pane > Modules > Sales and marketing > Commissions > Customer groups

for commissionfor commission.

2. Select NewNew .

3. In the GroupGroup field, type a value.

4. In the NameName field, type a value.

5. Select SaveSave.

6. Close the page.

7. Go to Navigation pane > Modules > Sales and marketing > Commissions > Item groupsNavigation pane > Modules > Sales and marketing > Commissions > Item groups .

8. Select NewNew .

9. In the GroupGroup field, type a value.

10. In the NameName field, type a value.

11. Select SaveSave.

12. Close the page.

13. Go to Sales and marketing > Commissions > Sales groupsSales and marketing > Commissions > Sales groups .

14. On the Action PaneAction Pane, select GeneralGeneral .

15. Click Sales rep.Sales rep.. The Sales rep. page displays a list of the company's sales people who are associated with a

specific commission group. You can assign multiple sales representatives to the same group and define their

respective share of the total commission fee as a percentage value. The total commission share across all

employees must not exceed 100.

16. In the list, mark the selected row.

17. Select EditEdit.

18. Set Commission shareCommission share to '50'.

19. Click NewNew .

20. In the NameName field, click the drop-down button to open the lookup.

21. Use the Quick FilterQuick Filter  to find records. For example, filter on the Name field with a value of 'Susan Burk'.

22. Click SelectSelect.

23. Set Commission shareCommission share to '50'.

24. Click SaveSave.

25. Go to Sales and marketing > Commissions > Commission calculationSales and marketing > Commissions > Commission calculation. In the CommissionCommission

A Commission sales group specifies the employees in sales representative roles who are eligible to

receive a commission when a customer associated with the relevant sales group buys certain items.

In the USMF demo data company, there is a sales group called "Sales reps US."

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/tasks/set-up-sales-commission-rules.md
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Assign a commission group to a customer and a product

calculationcalculation page, you define the commission rate that the employee is to receive for a sales transaction

when it contains the pre-set combination of customer and product. As part of the commission rate setup, you

must specify the commission calculation basis and whether it should include or exclude discounts. You can

also enter a validity period for when the commission rate is active.

26. Click NewNew .

27. In the Item codeItem code field, select 'Group'.

28. In the Item relationItem relation field, click the drop-down button to open the lookup.

29. In the list, find and select the group that you created earlier.

30. In the Customer codeCustomer code field, select 'Group'.

31. In the Customer relationCustomer relation field, click the drop-down button to open the lookup.

32. In the list, select the group that you set up earlier.

33. In the Sales rep. relationSales rep. relation field, click the drop-down button to open the lookup.

34. In the list, find and select the desired record.

35. In the Commission percentage field, enter a number.

36. Click SaveSave.

Keep the "Before line discount" option.

Keep the "Revenue" option as the basis for commission value calculation.

1. Go to Navigation pane Navigation pane > Sales and marketing > Commissions > Commission posting> Sales and marketing > Commissions > Commission posting.

Commission fees are payable to the employees and must therefore be set up to ensure correct financial

posting to the appropriate accounts in the General ledgerGeneral ledger . This is done in the Commission postingCommission posting page.

Review the setup that is available for the current company. Typically, the commission amounts are posted to a

dedicated expense account and are offset to a dedicated payable account. If you don't have the commission

posting rules set up, the system will fail to complete invoicing of a sales order which has eligible

commissions.

2. Close the page.

1. Go to Navigation pane > Modules > Sales and marketing > Customers > All customersNavigation pane > Modules > Sales and marketing > Customers > All customers .

2. In the list, find and select the desired record.

3. In the list, click the link in the selected row.

4. Click EditEdit.

5. Expand the Sales order defaultsSales order defaults  section.

6. In the Commission groupCommission group field, click the drop-down button to open the lookup.

7. In the list, select the group that you created earlier.

8. In the Sales groupSales group field, click the drop-down button to open the lookup.

9. In the list, find and select the desired record.

10. Click SaveSave.

11. Go to Navigation pane > Modules > Product information management > Products > ReleasedNavigation pane > Modules > Product information management > Products > Released

productsproducts .

12. Use the FilterFilter  to find records. For example, filter on the Item number field with a value of 'T0020 '.

13. In the list, click the link in the selected row.

14. Click EditEdit.

15. Expand the SellSell  section.

16. In the Commission groupCommission group field, click the drop-down button to open the lookup.

17. In the list, select the commission group that you created earlier.
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18. Select SaveSave.
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What is the Customer portal?

IMPORTANTIMPORTANT
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Video

Effective November 2020:

Common Data Service has been renamed to Microsoft Dataverse. For more information, see Power Automate Blog.

Some terminology in Microsoft Dataverse has been updated. For example, entity is now table and field is now column.

For more information, see Terminology updates.

This topic will be updated soon to reflect the latest terminology.

Modern supply chain systems rely on integration. They require that inventory, customer demand, and sales

departments be integrated instead of residing in separate silos. The Customer portal helps organizations that

run Microsoft Dynamics 365 Supply Chain Management enhance this integration and more effectively keep

their customers informed.

The Customer portal is a Power Apps portals template that lets companies create an externally facing business-

to-business (B2B) website for scenarios that are related to sales order processing. The template uses dual-write,

Supply Chain Management, and Power Apps portals to enable external enterprise customers to view and create

data from the company's Dynamics 365 environment.

The Customer portal template has all the customization capabilities that the portals feature of Power Apps

offers. The template can easily be modified to represent the company's brand, add increased functionality, and

change the user experience. All the functionality that the template offers out of the box can be modified as

desired.

By itself, the template isn't expected to be completely functional. It just serves as an enabler for customers who want to

create an externally facing website so that enterprise customers can engage with data from Supply Chain Management.

The Customer portal documentation is directed at admins, customizers, and system integrators who will set up the

Customer portal for a Supply Chain Management installation. It uses the terms customer and user to describe people

who are customers of the organization that is running Supply Chain Management, and who will use the final portal itself.

The Overview of the Customer portal template in Dynamics 365 Supply Chain Management video (shown

above) is included in the Finance and Operations playlist available on YouTube.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/customer-portal-overview.md
https://aka.ms/PAuAppBlog
https://go.microsoft.com/fwlink/?linkid=2147247
https://docs.microsoft.com/en-us/powerapps/maker/portals/overview
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/dual-write/dual-write-home-page
https://www.microsoft.com/videoplayer/embed/RE4ylwW
https://youtu.be/nPrqoLuHfV8
https://www.youtube.com/playlist?list=PLcakwueIHoT_SYfIaPGoOhloFoCXiUSyW


Who should use it?

How does it work?

The Customer portal is designed for companies that run Supply Chain Management and have these

characteristics:

They want to build an externally facing website that communicates order processing information (such as

order status or account information) directly from their Supply Chain Management system to their enterprise

customers.

They are transitioning from Dynamics AX 2012 to Supply Chain Management and previously used the AX

2012 Customer self-service portal.

The following types of organizations are notnot good candidates for implementing the Customer portal:

Companies that want to build a website for non-enterprise customers. These companies should consider

creating a Dynamics 365 Commerce e-commerce website.

Companies that are already using an existing Power Apps portals website for a similar purpose. These

companies won't receive any additional benefits from the Customer portal. The Customer portal is delivered

as a template that acts as a guide and a starting point for customers who want to "connect the dots" between

dual-write, Supply Chain Management, and Power Apps portals. If you've already set up a website that serves

this purpose, you might not gain much value from using the Customer portal template to re-provision that

website.

The Customer portal is provided as a Power Apps portals template. It depends on Power Apps portals and dual-

write.

Power Apps portals is a feature that lets users create an externally facing website that people from outside the

organization can sign in to. Little to no coding is required to make portals. The Customer portal is one of many

Dynamics 365 portal templates that are available from Microsoft.

Dual-write is an out-of-box infrastructure product that provides near-real-time interaction between customer

engagements apps and Finance and Operations apps. Dual-write provides bidirectional integration between

Finance and Operations apps and Microsoft Dataverse. Therefore, it provides an integrated user experience

across the apps. The Customer portal depends on tables that are synced with dual-write. Before data from

Supply Chain Management can be surfaced in the Customer portal, dual-write must be enabled for all the

appropriate tables.

The Customer portal acts as a starting point for organizations that want to use Power Apps portals to build an

externally facing website that uses data from their Supply Chain Management installation. It helps organizations

connect dual-write, Supply Chain Management, and Power Apps portals.

https://docs.microsoft.com/en-us/dynamicsax-2012/appuser-itpro/about-the-customer-self-service-portal
https://docs.microsoft.com/en-us/dynamics365/commerce/create-ecommerce-site
https://docs.microsoft.com/en-us/powerapps/maker/portals/overview
https://docs.microsoft.com/en-us/powerapps/maker/portals/portal-templates#environment-with-model-driven-apps-in-dynamics-365
https://docs.microsoft.com/en-us/powerapps/maker/portals/overview
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Licensing requirements

Dependencies on dual-write and Power Apps portals

Required setup to enable the Customer portal

Effective November 2020:

Common Data Service has been renamed to Microsoft Dataverse. For more information, see Power Automate Blog.

Some terminology in Microsoft Dataverse has been updated. For example, entity is now table and field is now column.

For more information, see Terminology updates.

This topic will be updated soon to reflect the latest terminology.

To implement the Customer portal, you must have the following licenses:

Power Apps por talsPower Apps por tals  – This license is required to host the Customer portal. Portals are licensed based on

usage. For more information, see the Power Apps portals licensing requirements.

Dual-writeDual-write – You must have the necessary licenses to enable dual-write for Supply Chain Management

tables. For more information, see the system requirements for dual-write.

The Customer portal depends on Power Apps portals and dual-write, as shown in the following illustration.

Unlike other features from Supply Chain Management, the Customer portal template resides in Power Apps

portals. Therefore, the Customer portal is limited by the functionality and capabilities that are provided by

Power Apps portals and the tables in dual-write.

After you've made sure that you have the required licenses, you can set up dual-write as described in the dual-

write initial synchronization instructions.

Be sure to enable the following table mappings in dual-write:

Sales Order Header

Sales Order Details

Accounts

Contacts

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/customer-portal-setup.md
https://aka.ms/PAuAppBlog
https://go.microsoft.com/fwlink/?linkid=2147247
https://docs.microsoft.com/en-us/power-platform/admin/powerapps-flow-licensing-faq#portals
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/dual-write/dual-write-system-req
file:///T:/eiye/ac1a/dynamics365/fin-ops-core/dev-itpro/data-entities/dual-write/initial-sync.html


Provision the Customer portal
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Update the Customer portal

Additional resources
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Products

After this setup is completed, you can provision the Customer portal template.

Before you begin, make sure that you've already completed the required setup. Then follow these steps to

provision the Customer portal.

1. Go to make.powerapps.com.

2. Make sure that you're using the environment where you enabled dual-write.

3. On the CreateCreate tab, scroll down to the Star t from templateStar t from template section, and select the template that is named

Customer Por talCustomer Por tal .

4. Follow the on-screen instructions.

After provisioning is completed, you can access the Customer portal in the Your appsYour apps  section of the HomeHome

page.

If the dual-write solution isn't installed in the environment that you're working in, you will receive an error message, and

the Customer portal won't be provisioned.

More functionality might be added to the Customer portal later. Any changes that Microsoft makes to the

underlying solution components will automatically appear in your environment. However, the website that is

provisioned in your environment won't automatically reflect changes that are made to the configuration data.

You will have to manually apply those changes by getting the code from the new template and merging it with

the provisioned website.

To learn how you can set up and customize the Customer portal, you should start by reviewing the following

documentation for the underlying technologies:

Power Apps portals documentation

Dual-write documentation

To effectively manage your portals, you must understand the Power Apps portals and Microsoft Dataverse

lifecycle. For more information, see the following resources:

About portal lifecycle

Upgrade a portal

Migrate portal configuration

Solution Lifecycle Management: Dynamics 365 for Customer Engagement apps

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://make.powerapps.com/
https://docs.microsoft.com/en-us/powerapps/maker/portals/overview
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/dual-write/dual-write-home-page
https://docs.microsoft.com/en-us/powerapps/maker/portals/admin/portal-lifecycle
https://docs.microsoft.com/en-us/powerapps/maker/portals/admin/upgrade-portal
https://docs.microsoft.com/en-us/powerapps/maker/portals/admin/migrate-portal-configuration
https://www.microsoft.com/download/details.aspx?id=57777
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Video

Prerequisite setup

Effective November 2020:

Common Data Service has been renamed to Microsoft Dataverse. For more information, see Power Automate Blog.

Some terminology in Microsoft Dataverse has been updated. For example, entity is now table and field is now column.

For more information, see Terminology updates.

This topic will be updated soon to reflect the latest terminology.

In the out-of-box implementation, there is no way for users to self-register for websites that are created by using

the Customer portal. To sign in and use a website, users must be invited by the admin. Microsoft has

intentionally blocked the ability of users to self-register.

Before a user can use a website, a contact record must be created for that user. This record indicates which

customer account and legal entity the user belongs to. This information is essential for ensuring that the user

can create and view sales orders.

When users self-register, contact records are automatically created for them. Therefore, you can't ensure that a

user selects the correct customer account and legal entity. On the other hand, the invitation process lets an

admin assign the correct customer account and legal entity to the contact record before an invitation is sent. If

you're thinking about customizing the solution so that users can self-register, be sure to consider the possible

consequences.

The Invite customers to register and use your customer portal video (shown above) is included in the Finance

and Operations playlist available on YouTube.

Contacts in Power Apps portals are stored as records in the ContactsContacts  table in Microsoft Dataverse. Dual-write

then syncs these records to Microsoft Dynamics 365 Supply Chain Management as required.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/customer-portal-user-admin.md
https://aka.ms/PAuAppBlog
https://go.microsoft.com/fwlink/?linkid=2147247
https://www.microsoft.com/en-us/videoplayer/embed/RE4ADkI
https://youtu.be/drGUYHX9QIQ
https://www.youtube.com/playlist?list=PLcakwueIHoT_SYfIaPGoOhloFoCXiUSyW


The invitation process

Out-of-box web roles and table permissions

Out-of-box web rolesOut-of-box web roles

AdministratorAdministrator

Customer representativeCustomer representative

Before you start to invite new customers, make sure that you've enabled the ContactContact table mapping in dual-

write.

To invite an existing contact to the Customer portal, follow the steps in Invite contacts to your portals in the

Power Apps portals documentation.

Before you invite a customer to join the Customer portal, make sure that the customer's contact record is

available and set up in the following way:

1. Set the CompanyCompany  field to the legal entity that you want the customer to belong to in Supply Chain

Management.

2. Set the Account NumberAccount Number  field to the customer account number that you want the user to have in Supply

Chain Management.

After a contact is created, you should be able to see it in Supply Chain Management.

For more information, see Configure a contact for use on a portal in the Power Apps portals documentation.

User roles in Power Apps portals are defined by web roles and table permissions. A few roles are defined for the

Customer portal out of the box. You can create new roles, and you can modify or remove existing roles.

This section describes the web roles that are delivered with the Customer portal.

For more information about how to modify the out-of-box user roles, see Create web roles for portals and Add

record-based security by using table permissions for portals in the Power Apps portals documentation.

The administrator oversees and maintains the website. This person will provision and set up the Customer

portal. The administrator maintains the IT and security aspects of the portal, and makes sure that everything

runs smoothly. The administrator might also customize and/or change the portal by adding new functionalities,

creating new roles, and more.

A customer representative works for a customer company and is responsible for managing the orders that the

company places. The customer representative can see all the orders that have been placed for the company and

the users who placed them. Additionally, the customer representative can see information about the overall

account and which contacts can place orders on behalf of that account.

https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/invite-contacts
https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/configure-contacts
https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/configure-contacts
https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/create-web-roles
https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/assign-entity-permissions
https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/create-web-roles
https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/assign-entity-permissions


Authorized usersAuthorized users

Unauthorized usersUnauthorized users

ExampleExample
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Customer X
Orderer: Jane

Yes Yes Yes No No

Customer X
Orderer: Sam

Yes Yes No Yes No

Customer Y
Orderer: May

Yes No No No No

NOTENOTE

NOTENOTE

Authorized users can place orders and view the status of the orders that they have placed. However, they can't

view the status of orders that other users in their company have placed.

Unauthorized users can't view any data. They can see only public information, such as terms and conditions, and

details about the company that is running the Customer portal.

The following table shows which sales orders the users in each web role can see in the system.

Even though both Sam and Jane are contacts who work for customer X, they can see only the orders that they

themselves have placed and nothing else. Although May has an order in the system, she can't see that order in the

Customer portal, because she is an unauthorized user. (Additionally, she must have placed the order through some

channel other than the Customer portal.)

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE
Effective November 2020:

Common Data Service has been renamed to Microsoft Dataverse. For more information, see Power Automate Blog.

Some terminology in Microsoft Dataverse has been updated. For example, entity is now table and field is now column.

For more information, see Terminology updates.

This topic will be updated soon to reflect the latest terminology.

This topic describes the different pages that available in the Customer portal out of the box. It explains what the

pages do and how you can customize them.

The Customer portal offers a few webpages and actions out of the box. The following site map provides an

overview of those webpages and actions, and the roles that can perform the actions.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/customer-portal-customize.md
https://aka.ms/PAuAppBlog
https://go.microsoft.com/fwlink/?linkid=2147247


Typical customizations
The following topics will help you learn the basics about Power Apps portals and how you can customize

portals:

Work with templates – This topic provides a general overview of how Power Apps portals works and how

you can do simple customizations of portals.

Manage portal content – This topic explains how you can manage and customize the content that you surface

in your portal.

Edit CSS – This topic helps you make more complex customizations to the user interface (UI) of your portal.

Create a theme for your portal – This topic helps you create a UI theme for your portal.

Create and expose portal content easily – This topic helps you manage the underlying data and tables that

you use for your portal.

Configure a contact for use on a portal – This topic explains how to create and customize user roles, and how

security and authentication work in Power Apps portals.

Configure notes for table forms and web forms on portals – This topic explains how to add documents and

additional storage to your portal.

https://docs.microsoft.com/en-us/powerapps/maker/portals/work-with-templates
https://docs.microsoft.com/en-us/dynamics365/portals/manage-portal-content
https://docs.microsoft.com/en-us/powerapps/maker/portals/edit-css
https://docs.microsoft.com/en-us/dynamics365/portals/create-theme
https://docs.microsoft.com/en-us/dynamics365/portals/create-expose-portal-content
https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/configure-contacts
https://docs.microsoft.com/en-us/powerapps/maker/portals/configure-notes


Customize the order creation process

The out-of-box order creation processThe out-of-box order creation process

Error handling for portal website – This topic explains how to view portal error logs and store them in your

Microsoft Azure Blob storage account.

When a user submits an order by using the Customer portal, the order is automatically synced to the

corresponding Dynamics 365 Supply Chain Management environment. Because the user is an external

customer, some required information is intentionally hidden from him or her. This information will automatically

be filled in when the form is submitted.

This section shows how you should set up contacts to avoid errors. It explains fields that are automatically set

and how you can modify the value of those fields if you must.

Here are the standard steps for submitting an order from the Customer portal.

1. On the home page, select the Create orderCreate order  tile to open the Create OrderCreate Order  wizard.

2. On the Order InformationOrder Information page, set the following fields:

Requested receipt dateRequested receipt date – Specify the date of delivery.

Deliver y addressDeliver y address  – Enter the address that the order should be delivered to.

CompanyCompany  – Select the name of the customer company. This field is automatically set for non-admin

users.

Requisition numberRequisition number  – Enter the requisition number of the order. This field isn't required.

Ship to countr y/regionShip to countr y/region – Enter the country or region that the items will be delivered to. This field is

automatically set for non-admin users.

3. Select NextNext.

4. On the ItemsItems page, select Add ItemAdd Item.

https://docs.microsoft.com/en-us/powerapps/maker/portals/admin/view-portal-error-log


5. In the Item InformationItem Information dialog box, set the following fields:

Product NameProduct Name – Find and select a product to add to the order.

QuantityQuantity  – Enter the quantity of the selected product.

UnitUnit – Specify the unit of measure (for example, ea.ea., kgskgs , or boxbox).

Estimated net amountEstimated net amount – The value is calculated as the estimated price of the item × the quantity for

the selected unit.

6. Select SubmitSubmit to add the item to the order.

7. Repeat steps 4 through 6 until you've added all the items that you want to order.

8. When you've finished adding items, select NextNext on the ItemsItems page.

9. The Order InformationOrder Information page provides a summary of the order. Review the order contents and delivery

details. If everything looks correct, select SubmitSubmit to submit the order.



Standard data setupStandard data setup
To help ensure a smooth user experience, the Customer portal automatically fills in values for several required

fields. These values are based on information in the contact record of the customer who is submitting the order.

For each contact row that belongs to a customer who will use the Customer portal to submit orders, values

must be specified for the following required fields. Otherwise, errors will occur.

CompanyCompany  – The legal entity that the order belongs to

Potential customerPotential customer  – The customer account that is associated with the order

Pr ice listPr ice list – The custom price list for the customer

CurrencyCurrency  – The currency of the price

Ship to countr y/regionShip to countr y/region – The country or region that the items will be delivered to

The following fields are automatically set for the sales order table:

LanguageLanguage – The language of the order (By default, the value is taken from the contact record.)

Ship to countr y/regionShip to countr y/region – The country or region that the items will be delivered to (By default, the value is

taken from the contact record.)

Contact personContact person – The user who can be contacted for information about the order (By default, the value is

taken from the contact record.)

CompanyCompany  – The legal entity that the order belongs to (By default, the value is taken from the contact record.)

Potential customerPotential customer  – The customer account that is associated with the order (By default, the value is taken

from the contact record.)

Invoice customerInvoice customer  – The billing account of the order (The default value is the potential customer from the

contact record.)

Sales order nameSales order name – The name of the sales order (The default value is sales ordersales order .)

CurrencyCurrency  – The currency of the price (By default, the value is taken from the contact record.)

Pr ice listPr ice list – The custom price list for the customer (By default, the value is taken from the contact record.)

Deliver y address descr iptionDeliver y address descr iption – The delivery address of the sales order (The default value is deliver ydeliver y

address descr iptionaddress descr iption.)

https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/configure-contacts


Modify the order creation processModify the order creation process

Customize the home page

You can freely modify the appearance and UI of the Customer portal if you don't change the basic order creation

process. If you want to change the order creation process, there are a few points that you must keep in mind.

Don't remove the following columns from the sales order table in Microsoft Dataverse, because they are

required to create a sales order in dual-write:

CompanyCompany  – The legal entity that the order belongs to

NameName – The name of the sales order

CurrencyCurrency  – The currency of the price

Price listPr ice list – The custom price list for the customer

Ship to countr y/regionShip to countr y/region – The country or region that the items will be delivered to

Potential customerPotential customer  – The customer account that is associated with the order

LanguageLanguage – The language of the order (Typically, this language is the language of the potential customer.)

Deliver y address descr iptionDeliver y address descr iption – The delivery address of the sales order

For items, the following columns are required:

ProductProduct – The product to order

QuantityQuantity  – The quantity of the selected product

UnitUnit – The unit of measure (for example, ea.ea., kgskgs , or boxbox)

Ship to countr y/regionShip to countr y/region – The country or region of delivery

Deliver y address descr iptionDeliver y address descr iption – The delivery address of the order

You must make sure that your Customer portal somehow submits values for all these columns.

If you want to add columns to the page, or remove columns, see Create or edit quick create forms for a

streamlined data entry experience.

If you want to change how columns are preset and how values are set when the page is saved, see the following

information in the Power Apps portals documentation:

Prepopulate field

Set Value On Save

All the controls in the Customer portal are built-in Power Apps portals controls. You can customize them by

following the steps in Compose a page in the Power Apps portals documentation.

The only custom control that is included in the Customer portal template is used to create the tiles on the home

page.

To modify the tiles, follow these steps.

1. Open the Portal Management app.

https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/create-edit-quick-create-forms
https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/configure-web-form-metadata#prepopulate-field
https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/configure-web-form-metadata#set-value-on-save
https://docs.microsoft.com/en-us/powerapps/maker/portals/compose-page
https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/configure-portal


Resources

NOTENOTE

2. In the navigation pane on the left, select Page TemplatesPage Templates .

3. Select the page template that is named HomeHome.

4. In the Web TemplateWeb Template field, select the HomeHome link to open the source code for that page.

5. You should now see all the source code for the home page and can modify it as you require.

To learn more about how you can set up and customize the Customer portal, see the following resources:

Power Apps portals documentation

Dual-write documentation

About portal lifecycle

Upgrade a portal

Migrate portal configuration

Solution Lifecycle Management: Dynamics 365 for Customer Engagement apps

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/powerapps/maker/portals/overview
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/dual-write/dual-write-home-page
https://docs.microsoft.com/en-us/powerapps/maker/portals/admin/portal-lifecycle
https://docs.microsoft.com/en-us/powerapps/maker/portals/admin/upgrade-portal
https://docs.microsoft.com/en-us/powerapps/maker/portals/admin/migrate-portal-configuration
https://www.microsoft.com/download/details.aspx?id=57777
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Audience and purpose

Promotional fund and Trade allowance agreement

Promotional fundPromotional fund

Trade allowance management helps companies manage sales promotion programs that offer "pay-for-

performance" monetary rewards to customers that achieve volume and behavioral goals. The feature’s

capabilities are designed for companies that focus on comprehensive promote-to-profit processes, from

promotion fund budgeting and allocation, to allowance contract setup, to claims creation and processing, to

payment processing, to promotion effectiveness analysis.

This article will provide a broad overview of the Trade allowance management feature and will familiarize you

with the typical set of tasks that are involved in managing a sales promotion program. Several types of users

who have operational and decision making responsibilities are expected to use this functionality to achieve their

respective goals:

Allocating discretionary funds to the selected accounts, and setting up trade allowance agreements for

promotions, based on bill-backs and one-off lump sum payments (for an agreed service)

Running the negotiated promotion contracts through ongoing sales and generating bill-back claims

Calculating, approving, and processing the generated claims, and passing them on to Accounts receivable

(A/R) as deductions for payment settlement

Reconciling the customer’s short-pay with the deduction that is due

Tracking use of the promotional fund, and evaluating program profitability and effectiveness

The information in this document is intended for business decision makers in enterprise companies, in positions

such as purchase manager, chief financial officer (CFO), and accounting manager, who have the following

responsibilities:

High-level budgets and fund allocation

Planning and analyzing sales promotions

Managing staff that processes bill-back claims, runs payments based on merchandizing events, and settles

short-pays and deductions

People in these roles are looking for ways to achieve these goals:

Better use marketing promotional funds.

Flexibly accommodate different types of promotion programs and allowances.

Reduce the administrative burden and errors that are associated with monitoring promotion performance

and processing claims.

Improve cash flow forecasts by accruing for future liability.

Have a quantified basis for ongoing and future negotiations with customers about promotions.

A trade allowance agreement is an incentive program where pay-for-performance monetary rewards are

offered to customers that achieve specific volume targets and/or behavioral goals. Promotional funds are

budgeted expenditures. In that way, the promotional campaigns can be captured.

Funds that are allocated to trade allowance agreements are recorded on the FundsFunds  page. To open the FundsFunds

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/trade-allowance.md


Trade allowance agreementTrade allowance agreement

page, select Sales and marketingSales and marketing > Trade allowancesTrade allowances  > FundsFunds  > FundsFunds .

On the FundsFunds  page, you can view the details of promotional funds.

The GeneralGeneral  FastTab shows the period that the fund is valid for and its budgeted amount. In order for the fund

to be allocated to the promotion agreement, the StatusStatus  field must have a value of ApprovedApproved.

The CustomersCustomers  FastTab shows the customer hierarchy. To select the customers that the fund targets, drag them

so that they are under Fund customersFund customers . This FastTab also shows how the total amount of the fund is

distributed.

The ItemsItems FastTab shows the items that are included in the promotion.

After the fund definition is in place, the next step in promotion planning is to register promotion contracts

(which are known as trade allowance agreements), allocate funds, and define performance goals for each

merchandizing event.

Trade allowance agreements are recorded on the Trade allowance agreementsTrade allowance agreements  page. To open the TradeTrade

allowance agreementsallowance agreements  page, select Sales and marketingSales and marketing > Trade allowancesTrade allowances  > Trade allowanceTrade allowance

agreementsagreements .



LinesLines

Select HeaderHeader  to switch to the Header view.

On the GeneralGeneral  FastTab, the Order toOrder to and Order fromOrder from fields define the period when the agreement is valid.

An approval status of Internal approvedInternal approved for the agreement indicates that the agreement isn't yet valid and

can't be applied during sales order processing.

The AnalysisAnalysis  section of the GeneralGeneral  FastTab contains important fields that define the quantities and costs that

are used for promotion evaluation:

The Base unitsBase units  field specifies the quantity of products that must be sold to the selected customers before

the promotion is applied.

The Calculated ship quantityCalculated ship quantity  value is calculated based on the L ift percentLift percent value, which is a planned

target increase for this promotion.

The Trade allowance costTrade allowance cost field is calculated based on the quantities of the various events in the trade

allowance agreement.

On the CustomersCustomers  FastTab, in the list on the left, you can select and view customer groups, which are set up as

predefined hierarchies. You can then select the whole hierarchy or specific accounts as targets for the allowance

agreement.

On the ItemsItems FastTab, as on the ItemsItems FastTab of the FundsFunds  page, products are added to the agreement to

associate its sales with the allowance that was agreed on.

On the FundsFunds  FastTab, you can view the promotion funds that are associated with this contract. You can also

view the contract's event cost allocation. An event cost allocation of 100 percent means that this promotion will

be financed exclusively from one fund. Alternatively, a promotion agreement can draw on several funds, and can

use equal or differential percentage allocation.

Next, select L inesLines  to switch to the Lines view.

The Merchandizing eventsMerchandizing events  tab shows the types of events covered by an agreement. There are three types: bill

back, lump sum and off-invoice.

When you select the merchandizing event and then select the AmountsAmounts  tab, the details for the event are found.



Perform sales under the planned merchandising event and generate
bill-back claims

NOTENOTE

Process claims and pass them as deductions to A/R

In the Trade allowance linesTrade allowance lines  section, you specify the quantity or amount ranges that the customer must

achieve for definitions to obtain the rewards.

In the case of a merchandizing event of the Bill backBill back type, the upper section the AmountsAmounts  tab defines the rules

that the bill back will be applied, generated, and paid under. For example, the rules may specify the following

conditions for the bill back claim:

It’s based on the creation date of the sales order (the Calculation date typeCalculation date type value is CreatedCreated).

It’s calculated based on the sales order line’s amount before discounts, not the net amount, which includes

discounts (the Taken fromTaken from value is GrossGross ).

It’s based on the volume of the sold products, not the amount (the Rebate line break typeRebate line break type value is

QuantityQuantity ).

It’s calculated per period of a month (the Cumulate sales byCumulate sales by  value is MonthMonth).

It’s settled as a deduction, not by using A/P (the Payment typePayment type value is Customer deductionsCustomer deductions ).

In the case of a merchandizing event of the Lump sumLump sum type, the AmountsAmounts  tab shows the quantity that will be

paid to the customer in the form of a deduction when the customer achieves specific performance. An approval

status of OpenOpen indicates that the lump sum hasn't yet been paid.

To apply the agreement to sales orders that meet the agreement's conditions, the agreement's status must be

ConfirmedConfirmed.

When you create a sales order that has lines that fulfill the requirements of the agreement, you can view the

related information on the Sales orderSales order  page by selecting Sales order lineSales order line > ViewView  > Pr ice detailsPr ice details .

On the Pr ice detailsPr ice details  page, on the RebatesRebates  FastTab, the sales clerk can see a bill back from the valid trade

allowance agreement (the rebate program ID is shown) and the total amount that is applied to the line. This

amount is also shown in the Rebate amountRebate amount field in the Margin estimationMargin estimation section of the Pr ice detailsPr ice details

page.

When the sales invoice is posted, a corresponding bill-back claim is generated for each invoice line.

To see the Price detailsPrice details  page, on the Accounts receivable parametersAccounts receivable parameters  page, on the PricesPrices tab, select the EnableEnable

price detailsprice details  check box. I



Recalculate claimsRecalculate claims

Process claims and pass them to A/RProcess claims and pass them to A/R

The next steps in the process for handling bill-backs are to review, calculate, and approve claims, and then

convert them into deductions.

The Bill back workbench is where the promotion agreement owner periodically reviews and processes the

claims that are generated. It's also where the A/R administrator converts the approved claims into deductions or

regular payments, depending on the payment method for the claim.

On the Bill back workbenchBill back workbench page, you can review the claim lines. If the claims are in To be recalculatedTo be recalculated

status, they must be recalculated for any cumulative effect.

To recalculate the claims, on the Action Pane, select CumulateCumulate. Then, in the Cumulate rebatesCumulate rebates  dialog box,

select the customer.

As a result of the recalculation, the program generates new claims for the amounts to adjust the original claims

to the qualifying amount per unit. One adjustment claim is generated for each unique combination of a

customer, an item, a currency, a unit of measure, inventory dimensions, financial dimensions, and a sales tax

group. These adjustment claims have the same reference to the sales order and invoice number as the claims

that are being adjusted (that is, the claims that were originally created from the sales document). Unlike the

original claim, the adjustment claim doesn’t have values in the fields that describe the original sales order line’s

amounts and quantity.

After the recalculation is completed, the status of the claims is changed to CalculatedCalculated. To approve the claims, on

the Action Pane, select ApproveApprove.

The claims are now ready for A/R processing. To process them, on the Action Pane, select ProcessProcess .

Upon processing the claims, the status has changed to MarkMark and indicates that a journal posting (the journal

that is posted is the Rebate accrual journal, as specified in the A/R parameters) has caused the following events

to occur :

The claims have been transferred to the temporary customer balance as deductions.

The rebate accrual account has been credited to represent the future liability for the customer.

The rebate expense account has been debited to recognize the cost that was incurred in connection with the

sales.

To complete the process, the A/R clerk must now handle the accrual deductions by transferring them to the

customers balance as a credit note (liability).

To start the task, on the Action Pane of the CustomerCustomer  page, select CollectCollect > Settle transactionsSettle transactions . Then, on the

Settle transactionsSettle transactions  page, select FunctionsFunctions  > Bill back programBill back program. This rebate page shows all the bill-back

claims that were previously processed.

If you want to create a credit note, select the MarkMark check box for all lines, and then select FunctionsFunctions  > CreateCreate

credit notecredit note.

Upon credit note creation, a journal is posted. (The journal that is posted is the AR consumption journal, as

specified in the A/R parameters.) As a result, the real liability (credit) amount has been moved to the customer

balance. Financially, this situation implies that the following events have occurred:

The customer's receivable account has been credited.

The rebate accrual account has been debited.

To approve a merchandising event of the Lump sumLump sum type, select the event on the Trade allowanceTrade allowance

agreementsagreements  page, and then, on the AmountAmount tab, select ApproveApprove.



Settle the deduction that is due and the customer short-pay by using
the Deduction workbench

Analyze the effectiveness of the promotion and fund consumption

NOTENOTE

Often, in anticipation of bill-backs, customers choose to short-pay selected invoices. To prevent payment

reconciliation issues in the future, the A/R clerk registers those short-pays as deductions when he or she records

the actual customer payments. Then, on the Deduction workbench, those customer deductions can easily be

settled against the claim amounts that are due from the company.

To register a customer's short-pay in the Payment journal, select Accounts receivableAccounts receivable > PaymentsPayments  >

Payment journalPayment journal , and create a new payment journal. Then, on the Action Pane, select DeductionsDeductions . On the

DeductionDeduction page, you can create and track the amount that was short-paid.

The collection manager is now responsible for settling the open credit note transaction and the short-pay

transaction against each other in the Deduction workbench.

To manage deductions, select Sales and marketingSales and marketing > Trade allowancesTrade allowances  > DeductionsDeductions  > DeductionDeduction

workbenchworkbench. The upper section of the page contains lines that represent the short-pays from the customer. The

lower section of the page contains the customers open credit transactions.

To settle the deduction against the open transaction, mark the deduction line, and then, on the Open transactions

tab, mark the line. On the Action Pane, click Maintain > Match.

The status of the originating claims is now set to CompletedCompleted.

To get an overview of the program's key statistics and fund use, you can use several reports and analytical views

that are available in Trade allowance management.

On the Trade allowance activityTrade allowance activity  page, the Over viewOver view  tab shows the main details of the trade allowance

agreement. The other tabs show more specific details about the associated documents, payments, and other

events that are related to the program.

The Summar ySummar y  tab shows the total quantity of products that have been sold under the promotion, the sales

amount that has been invoiced, and the bill-backs and lump sums that have been paid.

The Bill back creditsBill back credits  tab contains the details of individual bill-backs that have been credited to the customer.

To get a more analytical overview of the various performance measures for the promotion, you can use the

Analysis view. To go to the Analysis view, click Sales and marketingSales and marketing > Trade allowancesTrade allowances  > Trade allowanceTrade allowance

agreementsagreements . On the Action Pane, click AnalysisAnalysis .

To get a more analytical overview of the various performance measures for the promotion, you can use the

Analysis view. To go to the Analysis view, click Sales and marketingSales and marketing > Trade allowancesTrade allowances  > Trade allowanceTrade allowance

agreementsagreements . On the Action Pane, click AnalysisAnalysis .
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Create and post a new trade agreement journal

This procedure shows you how to create a trade agreement where you register a new product sales price that

you've agreed with a specific customer. You can run this procedure in demo data company USMF or on your

own data. If you're using your own data, before you start this guide you need to make sure that a Trade

agreement journal name exists where the Default relation is set to "Price (sales)".

1. Go to Navigation pane > Modules > Sales and marketing > Pr ices and discounts > TradeNavigation pane > Modules > Sales and marketing > Pr ices and discounts > Trade

agreement journalsagreement journals .

2. Click NewNew .

3. In the NameName field, click the drop-down button to open the lookup.

4. In the list, find and select the desired record.

5. On Action PaneAction Pane, click L inesLines .

6. In the Account codeAccount code field, select 'Table'.

In this example, you're updating the price for a specific customer, which means you need to choose Table.

If you were updating the product's list price, you would select 'All', so that the new price is valid for all

customers. If you were differentiating prices among different customer segments, then you would select

Group. To select Group, you must have set up Customer price groups.

7. In the Account selectionAccount selection field, click the drop-down button to open the lookup.

8. In the list, find and select the desired record.

9. In the Item codeItem code field, select 'Table'.

When you are entering a trade agreement of type 'Price (sales)', you must only select 'Table' in the ItemItem

codecode field. This is because a price is an absolute value and cannot be same for all products or a group of

products.

10. In the Item relationItem relation field, click the drop-down button to open the lookup.

11. In the list, select the product you want to include in the agreement. Make a note of which product you've

selected.

12. In the FromFrom field, enter a minimum quantity.

If the customer has to order a minimum quantity before they can qualify for the new price, then you

need to specify that quantity here.

Enter a value in the ToTo field to specify the maximum quantity above which the agreement's price will

not be valid. If you offer prices and discounts based on multiple quantity breaks, then specify each

quantity bracket as a pair of minimum and maximum quantity in the FromFrom and ToTo fields respectively.

13. In the Amount in currency fieldAmount in currency field, enter a price.

14. Under the DetailsDetails  section, in the From dateFrom date field, enter a date from which this agreement will be valid.

15. Click SaveSave.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/sales-marketing/tasks/create-new-trade-agreement.md


View trade agreements for a product

Additional resources
WhitepaperWhitepaper

Community blogsCommunity blogs

NOTENOTE

16. Click ValidateValidate.

17. Click Validate selected linesValidate selected lines .

18. Click OKOK.

19. Click PostPost.

20. Click OKOK.

1. Go to Navigation pane > Modules > Product information management > Products >Navigation pane > Modules > Product information management > Products >

Released productsReleased products .

2. In the list, find and select the product whose price you have just updated.

3. On the Action PaneAction Pane, click SellSell .

4. Click View trade agreementsView trade agreements .

Review the details of the price trade agreement you have just created.

5. Close the page.

For more information, download the following white paper (written to support AX2012, but still applies for

Dynamics 365 Supply Chain Management)

Trade agreements

Sales prices in Dynamics 365 for Finance and Operations
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Business processes

Use Ser vice managementSer vice management to establish service agreements and service subscriptions, handle service orders

and customer inquiries, and to manage and analyze the delivery of services to customers. You can use service

agreements to define the resources that are used in a typical service visit. You can also use service agreements

to view how those resources are invoiced to the customer. A service agreement can also include a service level

agreement that specifies standard response times, and offers tools to record the actual time.

You can create service orders to manage information about scheduled and unscheduled visits by a service

technician to a customer site. Service orders include information such as:

1. The hours of work that the service technician will perform

2. The type of service or repair

3. The item to repair, including details about the symptoms and diagnosis

4. Any expenses and fees related to the service or repair

You can receive, process, and dispatch service requests. After you have created a service order, you can use

service stages to monitor progress and specify rules that control what actions are enabled in each stage. When a

service order is complete, you can sign off on the order to confirm that it is complete, and then post the order to

start the invoice process.

Use the reporting tools to monitor service order margins and subscription transactions, and print work

descriptions and work receipts.

The following diagram illustrates the high level business processes for Ser vice managementSer vice management, and shows

where service processes integrate with other modules.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/service-management/service-management-home-page.md


Service management at a glance

IM P O RTA N T  TA SKSIM P O RTA N T  TA SKS P RIM A RY  PA GESP RIM A RY  PA GES P O P UL A R REP O RT SP O P UL A R REP O RT S

Fulfill service agreements Service agreements Service order margin

Handle customer inquiries Service orders Work description

Dispatch board Transaction - subscription

Subscription fee transactions

Integration of Service management

NOTENOTE

Service management can be integrated with the following modules:

Sales and marketing overview

Human resources

Can you tell us about your documentation language preferences? Take a short survey.
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Example

Related topics

NOTENOTE

Service agreement groups are useful for sorting and filtering service agreements. Use service agreement

groups to group service agreements by, for example, company size, geographical location, or industry type.

Alternatively, you can use agreement groups to group service agreements by the level of service offered to a

customer.

In the Ser vice agreement groupSer vice agreement group field in the Ser vice management parametersSer vice management parameters  page, you can define a

default service agreement group. This group is suggested when you create a new service agreement.

You can group your service agreements according to the level of service offered.

The three agreement groups you have set up in your company are Gold, Silver, and Bronze.

A new service account manager has been employed in your company. The service manager is responsible for

dealing with all clients in the Gold agreement group. You can filter agreement records on the Gold agreement

group to find all of the agreements for which you must specify the new service manager as the person in

charge.

Create service agreement groups
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Create a service agreement from Service management

NOTENOTE

Create service agreement lines manually

Create a service agreement from Project

Related topics

This topic describes how to use features in the Service management and the Project management and

accounting modules to create service agreements.

1. Navigate to Ser vice managementSer vice management.

2. Select Ser vice agreementsSer vice agreements  to create a new service agreement line in the page header.

3. Select NewNew . Enter a description, select a reference to a project in the Project IDProject ID field, and fill in the rest of

the fields and lines for the service agreement. Select SaveSave.

4. On the RelationsRelations  tab, select Ser vice objectsSer vice objects  or Ser vice tasksSer vice tasks  to create service object relations or service

task relations for the service agreement. The service objects and tasks that you have created relations for can

be attached on the lines of the service agreement.

5. In the lower half of the page, create service agreement lines by copying lines from a service template,

another service agreement, or manually creating the service-agreement lines.

If you copy lines into the service agreement from another service agreement, you can indicate whether you also want to

copy service object and service task relations. If you copy these relations, they are added to any existing relations on the

service agreement. If you copy service-agreement lines from a service template, the service-object and service-task

relations are automatically copied as service-object relations and service-task relations on the new service-agreement

lines.

1. From the Ser vice agreementsSer vice agreements  page, add a service agreement line in the lines grid.

2. Enter the appropriate information for the service agreement line.

3. Select SaveSave to save the line, and then close the page.

1. Select Project management and accountingProject management and accounting.

2. Select All projectsAll projects .

3. Select the project from the list.

4. On the Action PaneAction Pane, select ManageManage. In the NewNew  Action group, select Ser viceSer vice and select Ser viceSer vice

agreementagreement.

5. Follow the steps in the section titled Create a ser vice agreementCreate a ser vice agreement as described earlier in this topic to enter

the project reference.

Develop and establish service agreements overview

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/service-management/create-service-agreements.md
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Example

Create a service agreementCreate a service agreement

P RO JEC TP RO JEC T STA RT  DAT ESTA RT  DAT E

Your project The date you specified for the project. In this example, the
current date is used.

Create a service agreement lineCreate a service agreement line

T RA N SA C T IO N  T Y P ET RA N SA C T IO N  T Y P E STA RT  DAT ESTA RT  DAT E SERVIC E  IN T ERVA LSERVIC E  IN T ERVA L

Hour The current date. Every 10 days

The service agreement interval indicates the frequency with which service order lines are created for service

agreement lines when you create service orders automatically.

When you create service orders automatically, service order lines are created according to the interval that you

have specified for the service agreement line from the start date of the agreement line.

If the Inter valInter val  field of a service agreement line in the Ser vice agreementsSer vice agreements  page is blank, the line is a one-time

event, and it is not used to create service orders repeatedly.

This example illustrates how a service interval will affect service agreement lines and service order lines on a

service order.

First, you create a service agreement and set the Combine ser vice ordersCombine ser vice orders  option to By ser vice agreementBy ser vice agreement.

1. Click Ser vice agreementsSer vice agreements

2. On the Action PaneAction Pane, on the Ser vice agreementSer vice agreement tab, in the NewNew  group, click Ser vice agreementSer vice agreement to

create a new service agreement.

3. Enter a description, select a project in the Project IDProject ID field, and enter a date in the Star t dateStar t date field.

4. In the Combine ser vice ordersCombine ser vice orders  field, select By ser vice agreementBy ser vice agreement.

You have now created the following service agreement:

Next, you create a service agreement line that has the transaction type HourHour .

To complete this part of the example, you must create a service interval of 10 days in the Ser vice inter valsSer vice inter vals

page.

1. Select the service agreement that you just created.

2. On the L inesLines  FastTab, click the AddAdd button to create a new line in the lower pane of the Ser viceSer vice

agreementsagreements  page.

3. In the Transaction typeTransaction type field, select HourHour .

4. In the WorkerWorker  field, select the worker who will deliver the service.

5. In the Ser vice inter valSer vice inter val  field, select the 10 days interval.

You have now created a service agreement line with the following information:

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/service-management/service-intervals.md


Worker The worker who will perform the
service.

T RA N SA C T IO N  T Y P ET RA N SA C T IO N  T Y P E STA RT  DAT ESTA RT  DAT E SERVIC E  IN T ERVA LSERVIC E  IN T ERVA L

Create planned service ordersCreate planned service orders

Service orders createdService orders created

Related topics

NOTENOTE

There is no time window specified for the line.

You can now create planned service orders and service order lines for the coming month.

1. In the Ser vice agreementsSer vice agreements  page, on the Action PaneAction Pane, on the DeliverDeliver  tab, click Planned ser vice ordersPlanned ser vice orders .

2. In the Create ser vice ordersCreate ser vice orders  page, enter the current date in the From dateFrom date field and a date that is one

month from the current date in the To dateTo date field.

3. Set the HourHour  slider to YesYes .

4. Click OKOK.

Because there is no grouping on the service order (defined by the By ser vice agreementBy ser vice agreement option in the

Combine ser vice ordersCombine ser vice orders  field), one service order line is created per service order.

Three service order lines have been created within the time frame that you specified in the Create ser viceCreate ser vice

ordersorders  dialog box. You can view the service order lines in the Ser vice agreementsSer vice agreements  page (Action PaneAction Pane >

DeliverDeliver  tab >ViewView  button).

Set up service intervals
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Example

Related topics

NOTENOTE

Service interval indicates the frequency with which service order lines are created for service agreement lines

when you create service orders.

1. Click Ser vice managementSer vice management > SetupSetup > Ser vice agreementsSer vice agreements  > Ser vice inter valsSer vice inter vals .

2. Create a new service interval.

3. Enter the ID and description of the service interval.

4. In the RangeRange field, select the range.

5. In the FrequencyFrequency  field, type the frequency. The frequency is the factor by which you must multiply the range

to obtain the interval for a service agreement.

6. Press Alt+SAlt+S  to save the service interval.

You want to create a service interval of 10 days.

Create a 10-day ser vice inter valCreate a 10-day ser vice inter val

1. Click Ser vice managementSer vice management > SetupSetup > Ser vice agreementsSer vice agreements  > Ser vice inter valsSer vice inter vals .

2. Create a new service interval.

3. Enter the ID and description of the service interval.

4. In the RangeRange field, select DailyDaily .

5. In the FrequencyFrequency  field, type 10.

6. Press Alt+SAlt+S  to save the service interval.

Service intervals
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M ET H O DM ET H O D DESC RIP T IO NDESC RIP T IO N

Week The date that the service order line can be moved to any
open day in the same week as the initial calculated date.

Month The date that the service order line can be moved to any
open day in the same month as the initial calculated date.
For example, the calculated date for a service order line is
February 15, 2017. The service order line can be scheduled
for any weekday between February 1 and February 28,
2017.

Manual You define the maximum number of days before or after the
initial calculated date that the service order line can be
moved.

Related topics

NOTENOTE

You can use time windows to optimize the scheduling of service order lines. You can set up the system so that it

automatically creates service orders. Based on the criteria specified by a time window, you can connect as many

service order lines as possible to as few service orders as possible.

Time windows specify how far a service order line can move from its calculated date. The calculated date is the

date when the service order line was scheduled to occur. The date is based on its interval setting and the service

period that you defined in the Create ser vice ordersCreate ser vice orders  page. You define a time window by using the values in

the following table.

If you do not specify a time window for a service agreement line, the service order line that is derived from the

service agreement must be on the exact date for which it was originally scheduled.

Create time windows
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Related topics

NOTENOTE

You can use time windows to optimize the scheduling of service order lines.

1. Click Ser vice managementSer vice management > SetupSetup > Ser vice agreementsSer vice agreements  > Time windowTime window .

2. Press Alt+NAlt+N to create a new time window.

3. In the Time windowTime window  field, enter a name for the time window.

4. In the Descr iptionDescr iption field, enter a description for the time window.

5. In the MethodMethod field, select the method to be autocreated. If the method is of the ManualManual  type, specify the

number of days before or after the calculated date that the service order line can be moved.

Time windows
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NOTENOTE

You can use service template groups to sort and filter service templates.

1. Click Ser vice managementSer vice management > SetupSetup > Ser vice agreementsSer vice agreements  > Ser vice template groupsSer vice template groups .

2. Create a new service template group.

3. Enter the group ID, a description, and a parent service template group, if there is one.

4. Save the service template group.

5. Set the Tree controlTree control  slider to YesYes  to open the tree view and view the service template groups either as a

hierarchy in a tree view or as an overview.
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Create a service task

Example

Service agreementService agreement

P RO JEC TP RO JEC T SERVIC E  A GREEM EN TSERVIC E  A GREEM EN T DESC RIP T IO NDESC RIP T IO N GRO UPGRO UP

9012 000008_001 Inspection and routine
replacement – GB-1234

Premium

Service agreement linesService agreement lines

DESC RIP T IO NDESC RIP T IO N T RA N SA C T IO N  T Y P ET RA N SA C T IO N  T Y P E SERVIC E  O B JEC TSERVIC E  O B JEC T SERVIC E  TA SKSERVIC E  TA SK

Inspection and cleaning Hour GB-1234 I/C - GB1234

Travel Expense GB-1234 I/C - GB1234

Materials Item GB-1234 I/C - GB1234

Use service tasks to describe the task to be completed during a service order. Both technicians and customers

can see this information.

You create service tasks in the Ser vice tasksSer vice tasks  page, and you associate service tasks with a specific service

agreement or service order by creating service task relations. Every time that you create a service task relation,

you can create the following:

Internal notes for the task, such as detailed technical requests for the task that are important for the

technician to know.

External notes that the customer can see. These might provide a less technical explanation of the task that

is being completed, according to the agreement between the customer and the service company.

When you have set up a service task relation between a service task and a service order or service agreement,

you can specify this service task when you create service order lines or service agreement lines for the current

service order or service agreement.

When you generate service orders from a service agreement, you can use the service tasks that are assigned to

each service agreement line to group service order lines into service orders.

1. Click Ser vice managementSer vice management > SetupSetup > Ser vice tasksSer vice tasks .

2. Create a new line.

3. Enter the service ID and description.

A technician must complete two jobs on a gearbox (service object GB-1234) at a customer site. A service

agreement is created for the customer, and several transactions are associated with the jobs. The service

agreement and service agreement lines for the two jobs are as follows:

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/service-management/service-tasks.md


Routine replacement Hour GB-1234 RR - GB1234

GR-1 Item GB-1234 RR - GB1234

GR-5 Item GB-1234 RR - GB1234

DESC RIP T IO NDESC RIP T IO N T RA N SA C T IO N  T Y P ET RA N SA C T IO N  T Y P E SERVIC E  O B JEC TSERVIC E  O B JEC T SERVIC E  TA SKSERVIC E  TA SK

Service tasksService tasks

SERVIC E  TA SKSERVIC E  TA SK DESC RIP T IO NDESC RIP T IO N IN T ERN A L  N OT EIN T ERN A L  N OT E EXT ERN A L  N OT EEXT ERN A L  N OT E

I/C - GB1234 Inspection of gearbox GB-
1234

Visual and mechanical
inspection and cleaning of
gearbox GB-1234

Routine inspection of
gearbox

RR - GB1234 Routine replacement of
parts in GB-1234

Routine service replacement
of GR-1 and GR-5
components (for gearboxes
manufactured before 2002,
also replace GR-2
component)

Routine replacement of
parts

Group service orders

NOTENOTE

The service agreement lines for the two jobs have two service tasks attached to them. The service tasks

determine the transactions that belong to each job. In the first case, service task I/C - GB1234 identifies all the

service agreement lines that are involved in the inspection and cleaning of object GB-1234. In the second case,

service task RR - GB1234 identifies all the service agreement lines that are involved in completing a routine

replacement job.

The service task relations that connect the service tasks to the specific agreement are as follows:

When you create service orders automatically, you can use service tasks as grouping criteria. To group service

orders by service tasks, define on the service agreement that service orders that are based on the service

agreement should be grouped by service task ID as their initial grouping criteria.

Group by ser vice taskGroup by ser vice task

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice agreementsSer vice agreements  > Ser vice agreementsSer vice agreements .

2. On the SetupSetup tab, select By ser vice taskBy ser vice task in the Combine ser vice ordersCombine ser vice orders  field.
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Create a relation with a service agreement

Create a relation with a service order

See also

You can associate service tasks with service agreements or service orders in order to describe the service task to

be completed for the agreement or order. This information is available to service technicians and customers.

1. Go to Ser vice managementSer vice management > CommonCommon > Ser vice agreementsSer vice agreements  > Ser vice agreementsSer vice agreements .

2. Select an existing service agreement, or create a new service agreement.

3. On the Action Pane, select the Ser vice tasksSer vice tasks  button.

4. On the Ser vice tasksSer vice tasks  form, select NewNew  to create a new line, and then select a service task from the

Ser vice taskSer vice task list to attach the service task to the service agreement.

5. On the Descr iptionDescr iption tab, enter any internal or external note descriptions in the free text fields.

6. Close the form to save the record.

Repeat this procedure until you have created all the necessary service task relations for the service agreement.

You can now specify these service tasks for any attached agreement lines.

A service tasks relation that is created on a service agreement is available from all service orders that are

attached to the service agreement.

1. Go to Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders .

2. Select an existing service order, or create a new service order.

3. On the Action Pane, select the Ser vice tasksSer vice tasks  button.

4. From the Ser vice tasksSer vice tasks  form, select NewNew  to create a new line, and then select a service task from the

Ser vice taskSer vice task list to attach the service tasks to the service order.

5. On the Descr iptionDescr iption tab, enter any internal or external note descriptions in the free text fields.

6. Close the form to save the record.

Repeat this procedure until you have created all the necessary service task relations for the service order. You

can now select the service task for which you have created the relation when you create service order lines.

Service task relations that are created on a service order are available on the specific service order.

Service tasks overview
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Service objects are a customer’s assets and products for which you can perform a service. Depending on the

type of service you provide, objects can be tangible or intangible:

Tangible objects are things, such as a machine or a building, on which you can perform a physical service

task.

A tangible service object can also be an inventory item that you create in the Released product details

form. Depending on the inventory dimension group that you attach to the item, you can create a service

object to a level of detail that includes the item serial number. This is useful when you must keep track of

the exact item that the service object represents.

A tangible service object can also be an item that is not directly related to a company's direct production

or supply chain. For example, a tool kit that is used for repairs in a service order can be a service object

that is not included in inventory. In this case, you don’t register it as an inventory item.

Intangible objects are nonphysical things, such as a set of accounts or a legal document, on which you

can perform a service task.

Company A maintains the financial records for several small companies. One of Company A's clients is the local

football team, for which Company A does the weekly bookkeeping and annual audit of the club's accounts. The

club's accounts are set up in the Service objects form and specified as the object in the service agreement. There

are two service agreement lines for the object. Line 1 is weekly bookkeeping with a weekly interval assigned to

the line, and line 2 is the annual audit with a yearly interval assigned to it.

Create service objects
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Create a relation with a service agreement
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You can associate service tasks with service agreements or service orders in order to describe the service task to

be completed for the agreement or order. This information is available to service technicians and customers.

1. Go to Ser vice managementSer vice management > CommonCommon > Ser vice agreementsSer vice agreements  > Ser vice agreementsSer vice agreements .

2. Select an existing service agreement, or create a new service agreement.

3. On the Action Pane, select the Ser vice tasksSer vice tasks  button.

4. On the Ser vice tasksSer vice tasks  form, select NewNew  to create a new line, and then select a service task from the

Ser vice taskSer vice task list to attach the service task to the service agreement.

5. On the Descr iptionDescr iption tab, enter any internal or external note descriptions in the free text fields.

6. Close the form to save the record.

Repeat this procedure until you have created all the necessary service task relations for the service agreement.

You can now specify these service tasks for any attached agreement lines.

A service tasks relation that is created on a service agreement is available from all service orders that are

attached to the service agreement.

1. Go to Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders .

2. Select an existing service order, or create a new service order.

3. On the Action Pane, select the Ser vice tasksSer vice tasks  button.

4. From the Ser vice tasksSer vice tasks  form, select NewNew  to create a new line, and then select a service task from the

Ser vice taskSer vice task list to attach the service tasks to the service order.

5. On the Descr iptionDescr iption tab, enter any internal or external note descriptions in the free text fields.

6. Close the form to save the record.

Repeat this procedure until you have created all the necessary service task relations for the service order. You

can now select the service task for which you have created the relation when you create service order lines.

Service task relations that are created on a service order are available on the specific service order.

Service tasks overview
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This topic explains how to attach an inventory item to a service object. When you attach an item to a service

object, you can control and report the service activities that are performed for the item.

Before you can attach items to service objects, you must create the items in the Released product detailsReleased product details

form.

Use the following steps to attach an inventory item to a service object:

1. Click Ser vice managementSer vice management > SetupSetup > Ser vice objectsSer vice objects  > Ser vice objectsSer vice objects .

2. In the Item numberItem number  field, select the item to attach to the service object.

3. Save the service object.

The item is now attached to the service object, and any inventory dimensions specified for the item are also

copied to the service object.

Service objects overview
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Group by geographical location

Example

Group by type

Example

Create service object groups

Object groups are useful for sorting and filtering the data about objects for reports and statistics. For example,

you can group objects by geographical location or by type.

You can use this grouping method to show where the various different objects that your company services are

located. Grouping objects by geographical location can also be useful if, for example, you must identify the

objects that your company already provides services for in a particular country/region.

A customer from Belgium calls your service center and wants to create a service agreement for an object, ABC.

You have attached an object group for geographical location, Belgium, to all objects that are serviced in Belgium.

By using this group as a filter, you can quickly search to see whether you already have a record for ABC in the

program, or whether you must set up a new object.

You can use this grouping method to show the types of objects that your company services. Grouping objects by

type can also be useful if, for example, you want to create a new object based on similar objects that already

exist in the program.

A customer calls and wants to set up a service agreement for an air conditioning machine, HIJ. You do not

already have a record for this machine. However, you have set up an object group titled Air Conditioners, and

you have attached this group to all air conditioning objects. Therefore, you can quickly search for and identify all

other air conditioning machines and use the template information from these objects to create service

agreement lines for HIJ. By using object groups in this manner, you can quickly set up new objects and

determine the service tasks that must be performed on them.

Create groups that you can assign service objects to. Service objects are inventory items and other products for

which services are performed. By grouping service objects, you can create reports for similar and related service

objects. For example, a service object group might consist of two service objects: One service object is a kit, and

the second service object is the service to install the kit.

To create service object groups, follow these steps:

1. Click Ser vice management > Setup > Ser vice objects > Ser vice object groupsSer vice management > Setup > Ser vice objects > Ser vice object groups .

2. Click NewNew  to create a new service object group.

3. Enter a unique name for the service object group and, optionally, a description.

You can assign service objects to the group by using the Ser vice objectsSer vice objects  form.
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Use this procedure to set up a template that represents objects at a customer site.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice agreementsSer vice agreements  > Ser vice agreementsSer vice agreements .

2. Double-click a service agreement, or click Ser vice agreementSer vice agreement to create a new service agreement.

3. Click the SetupSetup tab.

4. Click Ser vice objectsSer vice objects  to attach a template bill of materials (BOM) to the service agreement.

5. In the Ser vice objectsSer vice objects  form, select a service object, and then click FunctionsFunctions  > Attach template BOMAttach template BOM.

6. In the Select template BOMSelect template BOM form, select a template BOM in the Template BOMTemplate BOM field, and then click

OKOK.

7. In the Ser vice objectsSer vice objects  form, click DesignerDesigner  to modify the template BOM so that the BOM represents

the objects that you want.

8. Close the forms to save your changes.

Manage template BOMs on object relations
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SERVIC E  O B JEC TSERVIC E  O B JEC T REL AT IO N  –  SERVIC E  A GREEM EN TREL AT IO N  –  SERVIC E  A GREEM EN T SERVIC E  B O MSERVIC E  B O M

EL-S/1000 ID SAL-001 BOM-EL-S/1000

EL-L/1000 ID SAL-001 BOM-EL-L/1000

T RA N SA C T IO N  T Y P ET RA N SA C T IO N  T Y P E C AT EGO RYC AT EGO RY SERVIC E  O B JEC TSERVIC E  O B JEC T

Hour Inspection EL-S/1000

Hour Gear box cleaning EL-S/1000

Item Cleaning materials EL-S/1000

Hour Inspection EL-L/1000

Hour Gearbox cleaning EL-L/1000

Item Cleaning materials EL-L/1000

You can create service object relations between a service object and a service agreement or service order. When

you create a relation, you attach the service object to the service agreement or service order.

After the relation is created, you can attach the service object to any lines on the service agreement or service

order.

You can also specify a template BOM for the object relation. The template BOM is a bill of materials for the

object on which you perform service. If you replace a component part of the service object during a service visit,

you can register this change in the service BOM by using the Service objects form.

You create a service agreement for servicing two elevators at a customer site. The service agreement has the

identifier ID SAL-001.

The elevators are set up in the Service objects form as objects, EL-S/1000 and EL-L/1000.

You attach the service objects, EL-S/1000 and EL-L/1000, to the service agreement.

You want to register changes in the BOM for the service object as you replace component parts of the object, so

you attach a service BOM to the service object relation, as described in the following table.

Because there are service object relations for the agreement, you can now create service agreement lines with

these objects, as shown in the following table.

On a service visit, you have to replace the gearbox for elevator EL-S/1000. To replace a component part of the
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object, you can access the BOM Designer by using the service object relation that you set up for the current

service agreement.

Access the BOM Designer by using a service object relation

1. Service agreements

2. Double-click a service agreement, or click Service agreement to create a service agreement.

3. Click the Setup tab.

4. Click Service objects to attach a template BOM to the service agreement.

5. In the Service objects form, click Designer to open the Designer form to modify the template BOM.

If you automatically create service orders for a service agreement, the service object relations in the agreement

are also created in the service orders.
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Create a service object relation for a service agreement

Create a service object relation for a service order
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This topic describes how to create service object relations for a service agreement and a service order. When

you a create service object relation, you associate the service object to a service agreement or service order.

When a customer requests service for an item that is a service object, you can select the service object from the

list of service object relations.

Use the following steps to create a service object relation for a service agreement:

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice agreementsSer vice agreements  > Ser vice agreementsSer vice agreements .

2. In the Ser vice agreementsSer vice agreements  list, select an existing service agreement, or click NewNew  to create a new

service agreement.

3. In the Ser vice agreementsSer vice agreements  form, on the Action PaneAction Pane, on the Ser vice agreementSer vice agreement tab, in the

RelationsRelations  group, click Ser vice objectsSer vice objects .

4. In the Ser vice objectsSer vice objects  form, click NewNew , and then select a service object for this service agreement.

5. To assign a template bill of materials (BOM) to the service agreement, click FunctionsFunctions , and then select

Attach template BOMAttach template BOM. In the Select template BOMSelect template BOM form, in the Template BOMTemplate BOM field, select a

template.

Use the following steps to create a service object relation for a service order :

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders .

2. In the Ser vice ordersSer vice orders  list, select an existing service order, or create a new service order.

3. In the Ser vice ordersSer vice orders  form, on the Action PaneAction Pane, on the Ser vice orderSer vice order  tab, in the RelationsRelations  group,

click Ser vice objectsSer vice objects .

4. In the Ser vice objectsSer vice objects  form, click NewNew , and then select a service object for this service order.

5. To assign a template BOM to the service agreement, click FunctionsFunctions , and then select Attach templateAttach template

BOMBOM. In the Select template BOMSelect template BOM form, in the Template BOMTemplate BOM field, select a template.

Service objects overview

Service object relations

Template BOMs
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Create a template BOM

Apply the template BOM to a service agreement or service order

Copy the history of a service BOM

A template bill of materials (BOM) provides you with a standardized list of components for service objects that

are serviced regularly. The components that are listed in the template BOM represent the individual

subcomponents of the service object. By applying a template BOM to a service object, you can keep a record of

the subcomponents that have been replaced on the service object.

To apply a template BOM to a service agreement or a service order, you attach it to a service object relation.

You can apply only one template BOM to a service object.

The following table contains information about the various methods that you can use to create a template BOM.

M ET H O DM ET H O D DESC RIP T IO NDESC RIP T IO N

Production The template BOM is based on a production order. This
option is applicable only if you operate in a production
environment. The benefit is that you have a current,
detailed listing of the components that make up an item.

Item BOM The template BOM is based on an item BOM. The item
BOM, unlike the production BOM, is a static list of the
components that make up an item.

Existing template The template is based on an existing template BOM.

Manual If you know what spare parts are typically replaced on a
service object, you can create your template BOM
manually. This method helps make sure that the
components that are included in the template reflect the
actual requirements of your workplace.

You can apply a template BOM to a service agreement, a service order, or both. The service agreement usually

covers a long-term relationship with a customer. The history of replacements that is recorded in the service

BOM is useful data to have for the service agreement.

You can also apply a template BOM to a service order to record the history of the service that has been

performed on a service object.
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Set up number sequences

You can copy the history of a service BOM line from one service agreement to another service agreement. By

copying the service history between service agreements, you can preserve the record of replacements for an

item.

ExampleExample

You have set up a three-year service agreement for a customer's car. During that period, the customer becomes

accustomed to the good service that the company provides. Therefore, after the agreement expires, the

customer wants to set up a new one. You are now able to negotiate a more favorable agreement for the

company. Because the record of replaced components might be useful in the future, you copy the history of the

service BOM to the new agreement.

If a template BOM has not been attached to a service object, you can modify or delete lines in it. After the

template BOM is attached to a service object, you can modify only the local version of the BOM. If you want to

duplicate the setup of a local version of a template BOM, you can create a new template BOM based on the local

version. For more information, see Modify a Service BOM.

If you replace an item in the BOM, you can register the replacement on the BOM line in the BOM designer.

Optionally, you can create a service order line for the replacement object. If you create a service order line, you

can invoice the replacement item. If you do not create a service order line for a replacement, the replacement

registration is kept to track the history of the service object.

You can change the way that information on the BOM line is displayed for all template and service BOMs. The

changes are applied to all template BOMs and service BOMs. This includes those that are attached to service

objects.

To use template BOMs, you must set up two number sequences. Set up one number sequence for the template

BOM and one for the BOM history line number.

Number sequences are used to allocate identifiers to records that require them. Before you can assign a number sequence

to a template BOM or a BOM history line number, you must set up number sequences codes.

1. On the Number sequencesNumber sequences  list page, create number sequences for template BOMs and the BOM

history line number.

2. Click Ser vice managementSer vice management > SetupSetup > Ser vice management parametersSer vice management parameters .

3. Click Number sequencesNumber sequences , and then select a number sequence code for the number sequence

references that you created in the Number sequencesNumber sequences  form.

4. Close the form to save your changes.
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The BOM history line number is used by the system to associate the transactions in the BOM history with a service

agreement or service order. The number is not displayed in the user interface.

Create a template BOM

Manage template BOMs on object relations

Modify a Service BOM
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Create a template BOM manually

Create a template BOM based on another template BOM

Create a template BOM based on an item BOM

You can create a template BOM by using any of the following methods. For all methods, the From dateFrom date and ToTo

datedate fields are optional and for information only.

1. Go to Ser vice managementSer vice management > SetupSetup > Ser vice objectsSer vice objects  > Template BOMsTemplate BOMs.

2. Select NewNew  to open the Create template BOMCreate template BOM form.

3. Under Copy BOM lines from referenceCopy BOM lines from reference, select the ManualManual  option.

4. In the Item numberItem number  field, enter an item of the type BOMBOM.

5. In the NameName field, enter a name for the template.

6. In the From dateFrom date and To dateTo date fields, enter a date interval in which the template BOM is active.

7. Select OKOK.

A new, blank template BOM is created.

1. Select Ser vice managementSer vice management > SetupSetup > Ser vice objectsSer vice objects  > Template BOMsTemplate BOMs.

2. Select NewNew  to open the Create template BOMCreate template BOM form.

3. Under Copy BOM lines from referenceCopy BOM lines from reference, select the Template BOMTemplate BOM option.

4. In the Reference numberReference number  field, select an existing template BOM to copy to your new template BOM.

5. In the NameName field, enter a name for the template.

6. In the From dateFrom date and To dateTo date fields, enter a date interval in which the template BOM is active.

7. Select OKOK.

A new template BOM is created by using lines that correspond to the lines in the original template BOM.

1. Select Ser vice managementSer vice management > SetupSetup > Ser vice objectsSer vice objects  > Template BOMsTemplate BOMs.

2. Select NewNew  to open the Create template BOMCreate template BOM form.

3. Under Copy BOM lines from referenceCopy BOM lines from reference, select BOMBOM.

4. In the Reference numberReference number  field, select a BOM version. An item of the type BOM is copied to the ItemItem

numbernumber .

5. In the NameName field, enter a name for the template.

6. In the From dateFrom date and To dateTo date fields, enter a date interval in which the template BOM is active.

7. Select OKOK.
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A new template BOM is created by using lines that correspond to the lines of the BOM listed in Bills ofBills of

mater ialsmater ials .

1. Select Ser vice managementSer vice management > SetupSetup > Ser vice objectsSer vice objects  > Template BOMsTemplate BOMs.

2. Select NewNew  to open the Create template BOMCreate template BOM form.

3. Under Copy BOM lines from referenceCopy BOM lines from reference, select ProductionProduction.

4. In the Reference numberReference number  field, select a production BOM.

5. In the NameName field, enter a name for the template.

6. In the From dateFrom date and To dateTo date fields, enter a date interval in which the template BOM is active.

7. Select OKOK.

A new template BOM is created by using lines that correspond to the lines of the BOM listed in BOMBOM.

Template BOMs
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A template bill of materials (BOM) can be attached to a service object relation. The service object relation can

then be associated with either service orders or service agreements.

1. Click Ser vice managementSer vice management > SetupSetup > Ser vice objectsSer vice objects  > Ser vice objectsSer vice objects .

2. Select a service object.

3. Click Ser vice agreementsSer vice agreements  or Ser vice ordersSer vice orders  to display the service agreements or service orders that

the service object has been associated with.

4. Select a service agreement or a service order, click FunctionsFunctions , and then click Attach template BOMAttach template BOM.

5. Select the template BOM to attach to the object.

To move an attached BOM to another service object or to delete an attached BOM, in the Ser vice objectsSer vice objects  form, click

FunctionsFunctions , and then click Move ser vice BOMMove ser vice BOM or Delete ser vice BOMDelete ser vice BOM.

Create service objects
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Turn reason codes on or off
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You can use reason codes to help explain the status of a service order when the stage of a service order is

updated. For example, if you cancel a service order, you can select a reason code for the cancellation.

To view information about reason codes that are used to track the progress of service orders, run the Service

order progress report. This report lists all service orders, regardless of their stage, and the reason codes that are

specified when a service order stage is updated.

Reason codes are optional. You can decide whether to require a reason code when you update a service order to

a specific service stage.

1. Click Ser vice managementSer vice management > SetupSetup > Ser vice ordersSer vice orders  > Ser vice stagesSer vice stages .

2. In the Ser vice stagesSer vice stages  form, select a service stage, and then select the ReasonReason check box for the service

stage.

3. Close the form to save your changes.

Set up service order stages
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Branching in service order stages
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You can set up stages for a service order to define the tasks that must be completed, the order in which they are

completed, and the workers who are responsible for completing them. By defining the stages for a service order

and assigning them to workers, you can control the flow of a service order through the tasks that various people

perform in the service organization. The sequence of stages must include an initial stage.

You can also define the actions that are permitted at each stage. For example, if you clear the PostPost check box for

all stages except the final stage, you prevent any service orders from being posted before the service orders are

processed through the complete sequence of stages.

When you set up a service stage, you can create multiple options, or branches, to select from for the next service

stage. All the branches that you create are available to select from when the initial stage is completed. For

example, you set up PlanningPlanning as an initial stage. You create two stages named In processIn process  and CancelCancel , and

then select PlanningPlanning as the parent for them. You assign the PlanningPlanning stage to sales order. When the planning

stage for the sales order is completed, you can select the In processIn process  stage if the sales order is ready to work on,

or you can select the CancelCancel  stage if the sales order is canceled.

Set up service order stages

Change the service order stage
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1. Go to Ser vice managementSer vice management > SetupSetup > Ser vice ordersSer vice orders  > Ser vice stagesSer vice stages .

2. Select NewNew  to create a new record.

3. In the Ser vice stageSer vice stage and Descr iptionDescr iption fields, specify a service stage ID and description.

4. Select the appropriate parameters for the stage.

5. Select the parent stage for the current stage or leave the ParentParent field blank if the stage is the initial stage

in the stage setup.

You cannot modify the ParentParent  field after you save the stage. Instead, you can delete the record and create the record

again with a different selection in the ParentParent  field.

Also, you can only create one stage with a blank ParentParent  field. That is, only one initial stage is permitted.
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1. Go to Ser vice managementSer vice management > SetupSetup > Ser vice ordersSer vice orders  > Stage reason codesStage reason codes .

2. Select NewNew  to create a new reason code.

3. Select SaveSave to save the reason code.

When you are prompted for a reason code to explain why you are updating a stage of the service order, you can

select any of the reason codes that you create here.
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Create a service level agreement

Apply a service level agreement

Apply the service level agreement to the service agreement

Apply the service level agreement to the service agreement group

Track time on a service order against an SLA

A service level agreement (SLA) is an agreement between a service company and a service customer. In a SLA,

the customer agrees to a minimum response time based on when the service company records the issue and

when the issue is resolved.

A SLA enforces a standard level of service that is offered to customers, and also makes it transparent to a

service company when a service job should be completed.

Any number of SLAs can be created to offer service customers different levels of service.

1. Click Ser vice managementSer vice management > SetupSetup > Ser vice agreementsSer vice agreements  > Ser vice level agreementsSer vice level agreements .

2. Type a name for the service level agreement in the Ser vice level agreementSer vice level agreement field.

3. Type the time that you want to allow for completion of service calls that are attached to the service level

agreement. Then select a calendar if you want to base the service level agreement on a specific calendar.

The SLA is applied directly to a service agreement.

Service orders that you create manually and attach to a service agreement that has an SLA are measured

against that SLA.

Service orders that you create automatically are not attached to an SLA.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice agreementsSer vice agreements  > Ser vice agreementsSer vice agreements . Select the

service agreement that you want to apply the SLA to, and then click EditEdit on the Action PaneAction Pane.

2. In the Ser vice level agreementSer vice level agreement field, select the SLA that you want to assign.

1. Click Ser vice managementSer vice management > SetupSetup > Ser vice agreementsSer vice agreements  > Ser vice agreement groupsSer vice agreement groups .

2. In the Ser vice level agreementSer vice level agreement field, select the SLA that you want to assign.

When you create a new service order for a service agreement that an SLA is assigned to, the time interval for

the delivery of the service is initiated, and the system starts to track the delivery time. Additionally, you can set

the following options:

You can start and stop time recording on the service order to register the total amount of time that is

spent on service orders.

You can monitor compliance with the time interval that is set in the service level agreement.
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You can define reason codes that must be set if the time interval of the service level agreement is

exceeded.

View compliance with service level agreements
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Update and index subscription sales prices

Subscription fee sales prices

When you create a subscription, the sales price is derived from the sales price setup that was created in the

Sales pr ice (subscr iption)Sales pr ice (subscr iption)  form.

In the Sales pr ice (subscr iption)Sales pr ice (subscr iption)  form, you can create sales prices for a specific subscription or you can create

sales prices that apply more broadly. For a sales price to be applied to a subscription, the period code and the

currency of the subscription must be identical to the period code and the currency of the sales price.

If the period code and currency are identical for the subscription and the sales price, subscription sales prices are

selected on the basis of the priorities listed in the following table. A blank cell in the table indicates an empty

field and an X indicates a value that is equal to the value in the subscription from which the transaction is

generated.

P RIO RIT YP RIO RIT Y C AT EGO RYC AT EGO RY P RO JEC T  IDP RO JEC T  ID
SUB SC RIP T ISUB SC RIP T I
O NO N

SA L ESSA L ES
C URREN C YC URREN C Y

P ERIO DP ERIO D
C O DEC O DE

1 X X X X X

2 X X X X

3 X X X X

4 X X X

5 X X X X

6 X X X

7 X X X

8 X X

When a subscription fee is created, the sales price with the greatest level of detail, as noted in the table above, is

selected as the subscription sales price.

You can update the subscription sales price by updating the base price or the index. You can update by a

percentage or to a new value.

When you create a subscription fee, the sales price is based on the sales price setup of the subscription. You can
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Example

either use the base price from the subscription price setup or create indexed sales prices.

You want to set up subscription sales prices of EUR 500 for a new project 9030. In the Sales pr iceSales pr ice

(subscr iption)(subscr iption)  form, you create a subscription sales price line as indicated in the following table.

VA L IDVA L ID
F RO MF RO M

C AT EGO RC AT EGO R
YY P RO JEC TP RO JEC T

SUB SC RIPSUB SC RIP
T IO NT IO N

P ERIO DP ERIO D
C O DEC O DE

SA L ESSA L ES
C URREN CC URREN C
YY

SA L ESSA L ES
P RIC EP RIC E

28-08-
2006

9030 Month EUR 500

Note that the Categor yCategor y  and Subscr iptionSubscr iption fields are empty.

You then create the following subscriptions.

SERVIC ESERVIC E
SUB SC RIP T ISUB SC RIP T I
O NO N P RO JEC TP RO JEC T

SUB SC RIP T ISUB SC RIP T I
O N  GRO UPO N  GRO UP C AT EGO RYC AT EGO RY C URREN C YC URREN C Y

P ERIO DP ERIO D
C O DEC O DE

00020_135 9030 Sub1 SubCat1 EUR Monthly

00021_135 9030 Sub1 SubCat2 EUR Monthly

Now you create subscription fees for both subscriptions in the subscription group Sub1:

1. Click Ser vice managementSer vice management > SetupSetup > Ser vice subscr iptionsSer vice subscr iptions  > Subscr iption groupsSubscr iption groups .

2. In the Subscr iption groupsSubscr iption groups  form, click FunctionFunction > Create subscr iption feeCreate subscr iption fee.

3. In the Create subscr iption feeCreate subscr iption fee form, enter the appropriate information. For more information, see

Create subscription fee transactions.

Subscription fees that have a sales price of EUR 500 are created for both subscriptions, as shown in the

following table.

P RO JECP RO JEC
T  DAT ET  DAT E

SERVICSERVIC
EE
SUB SCSUB SC
RIP T IORIP T IO
NN

P RO JECP RO JEC
TT

C AT EGC AT EG
O RYO RY

STA RTSTA RT
DAT EDAT E

EN DEN D
DAT EDAT E

SA L ESSA L ES
C URREC URRE
N C YN C Y

SA L ESSA L ES
P RIC EP RIC E

28-08-
2006

00020_
135

9030 SubCat
1

01-01-
2007

31-03-
2007

EUR 500

28-08-
2006

00021_
135

9030 SubCat
2

01-01-
2007

31-03-
2007

EUR 500

Later, you decide that you want to specify sales prices for the category SubCat1 for project 9030. Therefore, you

create a new sales price line that has a sales price of EUR 550 for the combination of project 9030 and fee

category SubCat1. There are now two subscription sales price lines for project 9030, as shown in the following

table.
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VA L IDVA L ID
F RO MF RO M

C AT EGO RC AT EGO R
YY P RO JEC TP RO JEC T

SUB SC RIPSUB SC RIP
T IO NT IO N

P ERIO DP ERIO D
C O DEC O DE

C URREN CC URREN C
YY

SA L ESSA L ES
P RIC EP RIC E

28-08-
2007

9030 Month EUR 500

28-08-
2007

SubCat1 9030 Month EUR 550

You repeat the procedure described above to create subscription fees for both subscriptions in the subscription

group Sub1. The following table shows the transactions that are created for each subscription that is attached to

the subscription group.

P RO JECP RO JEC
T  DAT ET  DAT E

SUB SCSUB SC
RIP T IORIP T IO
NN

P RO JECP RO JEC
TT

C AT EGC AT EG
O RYO RY

STA RTSTA RT
DAT EDAT E

EN DEN D
DAT EDAT E

SA L ESSA L ES
C URREC URRE
N C YN C Y

SA L ESSA L ES
P RIC EP RIC E

28-07-
2007

00020_
135

9030 SubCat
1

01-01-
2008

31-03-
2008

EUR 550

28-07-
2008

00021_
135

9030 SubCat
2

01-01-
2008

31-03-
2008

EUR 500

In the first transaction for subscription 00020_135, the sales price of EUR 550 derives from the subscription

sales price that is set up for the combination of the specific project and category. In the second transaction for

subscription 00021_135, the sales price of EUR 500 is used as the project subscription sales price because there

is no price set up for the combination of project 9030 and category SubCat2.

Update and index subscription sales prices
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Subscriptions share the following information, which is defined for the subscription group:

Number sequence code for the subscription, if any.

The invoicing period for which subscription transactions are created. For example, if the InvoicingInvoicing period

code in the Subscr iption groupsSubscr iption groups  form is set to Quar ter lyQuar ter ly , transactions for all subscriptions that are

attached to the subscription group are created on a quarterly basis.

How frequently the subscription is to be accrued, if at all.

You can also complete the following tasks for all subscriptions that are attached to the subscription group:

Create subscription transactions.

Update the base price or the index for the subscriptions.

Post accrued revenue for subscription transactions.

Subscription groups (form)

Set up subscription groups
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1. Go to Ser vice managementSer vice management > SetupSetup > Ser vice subscr iptionsSer vice subscr iptions  > Subscr iption groupsSubscr iption groups .

2. Select NewNew  to create a new subscription group.

3. In the Subscr iption groupSubscr iption group field, enter a name for the new subscription group.

4. In the InvoicingInvoicing field, select an invoicing frequency for the subscription. The invoicing frequency is

indicated by a period code that is set up in the Period typesPeriod types  form.

5. To accrue revenue for subscription transactions, select the Accrue revenueAccrue revenue check box, and then in the

AccrualAccrual  field, select a frequency. The accrual frequency is based on a period code that is set up in the

PeriodsPeriods  form.

Subscription groups (form)

Subscription groups
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Set up reason codes

Require reason codes when a service level agreement is canceled

Require reason codes when the a service order exceeds the time limit
that is set by the service level agreement
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You use a reason code to indicate why a service level agreement (SLA) has been canceled, or why a service

order has exceeded the time limit that is you define in the SLA.

You can also specify that a reason code is required when an SLA is canceled, or when the time limit exceeds the

time that is specified in the SLA for the service order.

If you have specified that a reason code is required, you must enter a reason code in the following situations:

When a service order is moved to a stage that stops time recording against the SLA for the service order.

When the service order is signed off.

When time recording is manually stopped.

1. Click Ser vice managementSer vice management > SetupSetup > Ser vice ordersSer vice orders  > Stage reason codesStage reason codes .

2. In the Stage reason codesStage reason codes  form, click NewNew  to create a new reason code.

3. In the Stage reason codeStage reason code field, enter a unique stage reason code.

4. In the Descr iptionDescr iption field, enter a description of the stage reason code.

5. Close the form to save your changes.

1. Click Ser vice managementSer vice management > SetupSetup > Ser vice management parametersSer vice management parameters .

2. In the Ser vice management parametersSer vice management parameters  form, click the GeneralGeneral  link, and then select the ReasonReason

code on cancelingcode on canceling check box.

1. Click Ser vice managementSer vice management > SetupSetup > Ser vice management parametersSer vice management parameters .

2. In the Ser vice management parametersSer vice management parameters  form, click the GeneralGeneral  link, and then select the ReasonReason

code on exceeding timecode on exceeding time check box.

Start and stop time recording on a service order
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Project prices

Project validation

Project line properties

Default offset accounts

Project categories
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Project parameters

When you work with service agreements and service agreement lines, you use data that is set up in the

following areas in Project management and accountingProject management and accounting.

The cost and the sales price for a service agreement transaction are derived from the cost price setup that

applies to the project that is attached to the service agreement. Cost and sales prices can be set up by project,

employee, and category.

The projects, employees, and categories that are available for selection on a service agreement line can be

limited by the validation setup in Project management and accountingProject management and accounting. By using the validation setup, you

can combine employees, projects, and categories for control access.

A line property is entered automatically for a service agreement line.

Line properties are created in the L ine proper tiesL ine proper ties  form in Project management and accountingProject management and accounting. The line

property that is entered on a service agreement is attached to the project that is selected for the service

agreement and inherited subsequently by the service agreement line.

If you enter an expense transaction, a default expense offset account is selected automatically for the transaction.

The default expense account is set up for the project that is attached to the current service agreement.

The categories that are available for service agreement lines are set up in the Project categoriesProject categories  form in

Project management and accountingProject management and accounting.

Categories that have the Active in journalsActive in journals  check box selected on the ProjectProject  tab in the Project categoriesProject categories  form are

available for selection. However, if the Inactive categoriesInactive categories  check box is selected on the JournalsJournals  tab in the ProjectProject

management and accounting parametersmanagement and accounting parameters  form, all categories are available for selection.

If the Terminated workersTerminated workers  field on the JournalsJournals  tab in the Project management and accountingProject management and accounting

parametersparameters  form is selected, you can select inactive employees and active employees in the Ser viceSer vice

agreementsagreements  and Ser vice ordersSer vice orders  forms.

Also, you can enable the Star t timeStar t time and End timeEnd time fields on the ProjectProject tab in the Ser vice ordersSer vice orders  form to

enter starting and ending times on service order lines.
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Enable the starting and ending time feature for service orders
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1. Click Project management and accountingProject management and accounting > SetupSetup > Project management and accountingProject management and accounting

parametersparameters .

2. Click the JournalsJournals  tab, and then select the Show star t/end timesShow star t/end times  check box.

3. Click Project management and accountingProject management and accounting > SetupSetup > JournalsJournals  > Journal namesJournal names .

4. Select the journal name that is attached to the service order.

5. Click the GeneralGeneral  tab, and then select the Show star t/end timesShow star t/end times  check box.

Select the journal name for the service order in the HourHour  field on the JournalsJournals  tab in the Ser vice managementSer vice management

parametersparameters  form.
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Setting up repair management

Symptoms and conditions

Diagnosis and resolutions

Repair stages

For repair management you can group problems systematically. This is to help with the suggestion of solutions

that have been successful in the past.

You set up symptoms, diagnosis, and resolution settings. All these can later be applied when you receive a

similar item for repair. You can also set up repair stages that can follow the progress of a repair issue.

Use the following setup forms to enter information that will be used to specify the symptoms, the diagnosis, and

the resolution, of the repair.

Ser vice managementSer vice management > SetupSetup > RepairRepair  > ConditionsConditions .

Ser vice managementSer vice management > SetupSetup > RepairRepair  > Symptom areasSymptom areas .

Ser vice managementSer vice management > SetupSetup > RepairRepair  > Diagnosis areasDiagnosis areas .

Ser vice managementSer vice management > SetupSetup > RepairRepair  > ResolutionsResolutions .

Ser vice managementSer vice management > SetupSetup > RepairRepair  > Repair  stagesRepair  stages .

Symptoms are how the customer characterizes the problem. Symptoms include the customer observations that

indicate the need for repair.

You can set up symptom areas, symptom codes, and conditions. The symptom area covers the area of

malfunction, and the symptom code covers the malfunction symptom. The condition describes the situation or

environment that is present when the problem occurs.

ExampleExample

A computer is brought in for repair because the hard drive fails after an extended period of use. The hard drive

failure causes a blue screen error. The technician who receives the computer enters the following symptoms and

conditions:

1. The symptom area is the hard drive

2. The symptom code is the blue screen error

3. The condition is that the hard drive fails after extended use

The diagnosis and resolution fields are statements from the repair perspective. These are the steps that a

technician went through to investigate the problem.

The diagnosis area covers the operation that must occur to solve the issue. The diagnosis code is how the

problem was handled, and the resolution could be that the item was repaired, replaced, or the order was

canceled by the customer. For example, if the computer is repaired, the diagnosis area could be "defective part,"

the diagnosis code could be "new video card installed," and the resolution could be "replaced."
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Applying repair management

Create a repair line on a service order

Tracking progress and resolving a repair issue

Close a repair line for a resolved issue

NOTENOTE

Repair stages state the progress of the repair process. The repair stage has a FinishedFinished sign-off parameter that

indicates that the repair line has been completed, and the finishing date and time has been recorded.

To apply repair management to an item, the item must be set up with a service object relation on a service order.

From the service order you can then create a repair line with information about the current issue. On the repair

line you define the service object that is in repair and information about symptoms, diagnosis, and execution.

You can also create a note for the repair line.

You can create repair lines for each step in the repair process.

1. Go to Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders .

2. Select the service order with the service object that needs repair.

3. Select RepairRepair  > Repair  linesRepair  lines  to open the Repair  linesRepair  lines  form.

4. Select NewNew  to create a new line.

5. Select a service object. You can select any service object that has been set up with an object relation on

the service order.

6. Select any of the preset symptoms, diagnosis, and execution values that are relevant in the repair line and

then select the NoteNote tab to create a note on the repair line, if needed.

7. Select SaveSave to save the new repair line. The Created date and timeCreated date and time field in the GeneralGeneral  tab of the

Repair  linesRepair  lines  form is updated with the time of saving.

You can set the repair stages of a repair line to track the progress of the repair.

When a repair issue is resolved, you can close the repair line. Set the repair stage to a stage with a FinishedFinished

property enabled. The current date and time is registered as the finish time on the line.

1. Open the Repair  linesRepair  lines  form. Follow the procedure earlier in this topic to create a repair line.

2. Select the repair line with the repair issue that you want to close.

3. In the Repair  stageRepair  stage field, select a stage with the FinishedFinished property enabled.
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Create and use return reason codes and disposition codes to support the process for returning products.

Use a return reason code to describe the reason that the customer wants to return an item. You can assign a

reason code in the Create return ordersCreate return orders  form.

Assign a disposition code when an item is received or during the physical inspection of a returned item. You can

use disposition codes to describe the condition of the item. You can also use disposition codes to indicate

whether additional action is required for the transaction. For example, create disposition codes for the following

actions:

Scrap the returned item and provide a replacement item to the customer.

Return the item to inventory and credit the customer for the cost of the item.

Repair the item and return it to the customer.

Set up return reason codes

Set up disposition codes
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You can set up disposition codes to specify how to process an item that is returned by a customer. For example,

create a disposition code named Repair  and returnRepair  and return to indicate that the returned item will be repaired and then

returned to the customer. For more examples of disposition codes that are typically used for items that are

returned by customers, see Specify how to dispose of returned items.

You can also set up a reason code to help explain why an item was returned. For more information about reason

codes, see Set up return reason codes.

1. Go to Sales and marketingSales and marketing > SetupSetup > Sales ordersSales orders  > ReturnsReturns  > Disposition codesDisposition codes .

2. Select NewNew  to create a new disposition code.

3. Enter a unique, descriptive name, select an action, and enter a description for the disposition code.

4. If you want to associate any customer charges with this disposition code, select the ChargesCharges  button to

open the Set up chargesSet up charges  form.

5. If you want to define any external codes to match with the company's own disposition codes, select the

External codesExternal codes  button to open the External codesExternal codes  form.

Customer returns overview

Disposition codes (form)

Auto charges (form)

External codes (form)
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Set up return reason code groups

Set up return reason codes
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1. Go to Sales and marketingSales and marketing > SetupSetup > Sales ordersSales orders  > ReturnsReturns  > Return reason code groupsReturn reason code groups .

2. Select NewNew  to create a line for a new return reason code group.

3. In the Return reason code groupReturn reason code group field, type an identifier for this group.

4. In the Descr iptionDescr iption field, type a brief phrase to explain how this group will be used.

This procedure helps you set up return reason codes that you can use to indicate why a product was returned by

the customer.

1. Go to Sales and marketingSales and marketing > SetupSetup > Sales ordersSales orders  > ReturnsReturns  > Return reason codesReturn reason codes .

2. Press CTRL + N to create a new return reason code line.

3. In the Return reason codeReturn reason code field, enter text to identify this code.

4. In the Descr iptionDescr iption field, enter text to describe the return reason code.

5. Use the Return reason code groupReturn reason code group drop-down list to add the code to a return reason code group.

Return reason code groups (form)

Return reason codes (form)
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When you handle a return order, you must specify a reason return code to identify why the product is being

returned. You must also specify a disposition code and a disposition action to determine what should be done

with the returned product itself.

A disposition code can be applied when you create the return order, register item arrival or packing-slip update

an item arrival, and end a quarantine order.

You can define any disposition codes that you need in order to support the business processes. The following

table provides a set of typically used codes to assign return-item disposition.

DISP O SIT IO N  T Y P EDISP O SIT IO N  T Y P E C O M M O N  C O DEC O M M O N  C O DE DESC RIP T IO NDESC RIP T IO N

Disposal SC Scrap/Destroy

Disposal DC Donate to Charity

Disposal TD Third-Party Disposal

Disposal SL Salvage

Disposal TS Third-Party Sale (Secondary
Markets)

Repair/Modify RW Rework

Repair/Modify RF Remanufacture/Refurbish

Repair/Modify MD Modify

Repair/Modify RP Repair

Repair/Modify RV Return to Vendor

Other AI Use as is

Other RS Resale

Other EX Exchange

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/service-management/specify-how-to-dispose-of-returned-items.md


Select a disposition code for a quarantine order

See also

NOTENOTE

Other MS Miscellaneous

For each disposition code that you define, you must select a disposition action. The disposition action

determines the physical and financial implications of the disposition codes. For example, the disposition action

determines the physical handling of the returned item, the financial effect of the returned item, and if a

replacement item must be sent to the customer. You can define an unlimited number of disposition codes

according to your business needs, but there are only six predefined disposition actions that you can select from.

The following table provides the disposition actions and their definitions.

DISP O SIT IO N  A C T IO NDISP O SIT IO N  A C T IO N DESC RIP T IO NDESC RIP T IO N

CreditCredit Return the item to inventory and credit the customer.

Credit onlyCredit only Credit the customer without requiring or expecting the
item to be returned.

ScrapScrap Scrap the item and credit the customer.

Replace and creditReplace and credit Return the item to inventory, create a replacement order,
and credit the customer.

Replace and scrapReplace and scrap Scrap the item, create a replacement order, and credit
the customer.

Return to customerReturn to customer Reject the returned item and return it to the customer.

1. Click Inventor y managementInventor y management > PeriodicPeriodic > Quality managementQuality management > Quarantine ordersQuarantine orders .

2. For an existing quarantine order, select an action from the Disposition codeDisposition code field on the Over viewOver view  tab.

Quarantine order (form)

Disposition codes (form)
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Customer service supports professional, service-based companies and manufacturing service organizations.

Customer service includes the following functionality:

Key processes for service management, such as service agreements, service orders, and return

management

An advanced setup for repair management that includes tracking of repairs and versioning for bills of

materials (BOMs)

Support for employee roles, such as service manager, dispatcher, and service technician or service

consultant

Service subscriptions, which can generate periodic streams of revenue that are independent of the

frequency of service

Service-level agreements that support a differentiated customer base

The topics in this section provide an overview of the Customer service business process and each business

process component. They also list the forms that are associated with each business process component, and

they discuss the tasks that are associated with each business process component.
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Forms for the Fulfill service contracts business process components

NOTENOTE

This topic provides an overview of the tasks to fulfill service agreements. The topic also lists the forms that are

associated with each business process component and discusses the tasks that are associated with each

business process component.

The following table lists the forms that support the Fulfill service contracts business process components. The

table entries are organized first by task, and then alphabetically by the name of the form.

To open some of the forms in the following table, you must enter information or parameter settings.

B USIN ESS P RO C ESS C O M P O N EN TB USIN ESS P RO C ESS C O M P O N EN T
TA SKTA SK F O RM  N A M EF O RM  N A M E USA GEUSA GE

Develop and establish agreement Ser vice agreementsSer vice agreements Create and maintain service
agreements.

SubscriptionSubscription Create and maintain service
subscriptions.

   

Monitor and implement
agreement

Change ser vice stageChange ser vice stage Select the next stage in the
workflow for a service order.

Ser vice ordersSer vice orders Create and maintain service
orders.

   

Update and evaluate contract Cancel ser vice levelCancel ser vice level
agreementagreement

Cancel the service level agreement
on a service order.

Cancel ser vice ordersCancel ser vice orders Cancel service orders, or reverse
the Canceled status of service
orders.

Index subscriptionIndex subscription Update the base prices and
indexes for subscriptions.
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Service agreement
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Service-agreement lines

Service agreements let you define the resources that are used in a typical service visit and how those resources

are invoiced to the customer.

Every service agreement is attached to a project through which transactions are posted and invoiced. However,

you can also invoice service order transactions directly through the project without first having to connect the

service order to a service agreement. You might decide to do this if the service order is for a one-time-only

service visit and the need for processing the service transactions quickly outweighs the need for maintaining

detailed service-agreement information about the customer over a period of time.

In each service agreement, you must specify a project, a service-agreement ID, and a service-agreement group.

The service-agreement group can be used to sort and organize service agreements.

A service agreement header contains settings that apply to all attached agreement lines:

Whether the service agreement is suspended. If the service agreement is suspended, you cannot generate

service orders from the service agreement.

The duration of the service agreement.

How service-order lines are to be combined into service orders.

Whether the service agreement is a template.

In the service-agreement header, you also set up all the service objects and service tasks that can be used with

the service agreement by entering the specific service tasks or service objects that are to be attached to the

various lines of the agreement.

From the service-agreement header, you can also copy service-agreement lines or service-template lines into

the current service agreement.

You can suspend service agreements and stop individual service agreement lines.

If you select the SuspendedSuspended check box on a service agreement, you cannot:

Create service orders automatically or manually from the service agreement.

If you select the StoppedStopped check box on a service agreement line, you cannot:

Create service orders automatically or manually from the service agreement line.

Copy the service agreement line into another service agreement or service order.

If a service agreement is suspended, all the attached lines are stopped, regardless of their individual status.

Each service-agreement line describes in detail the content of the proposed service work. The lines contain the

following settings:
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The transaction type and the description of the transaction type.

The employee who performs the service work.

The objects on which service must be performed for the service agreement.

The frequency with which work is performed and associated item, expense, and fee transactions are

registered.

The time window within which service-order lines can be grouped into a service order.

The service tasks that are used to group sets of agreement lines together into work tasks and to summarize

for service technicians and customers what service task is to be provided.

Whether a line is stopped. If a line is stopped, you cannot create service orders for that individual line.

Project settings, such as the category and the line property.

Create service agreements
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Create a service agreement from Service management
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Create service agreement lines manually

Create a service agreement from Project

Related topics

This topic describes how to use features in the Service management and the Project management and

accounting modules to create service agreements.

1. Navigate to Ser vice managementSer vice management.

2. Select Ser vice agreementsSer vice agreements  to create a new service agreement line in the page header.

3. Select NewNew . Enter a description, select a reference to a project in the Project IDProject ID field, and fill in the rest of

the fields and lines for the service agreement. Select SaveSave.

4. On the RelationsRelations  tab, select Ser vice objectsSer vice objects  or Ser vice tasksSer vice tasks  to create service object relations or service

task relations for the service agreement. The service objects and tasks that you have created relations for can

be attached on the lines of the service agreement.

5. In the lower half of the page, create service agreement lines by copying lines from a service template,

another service agreement, or manually creating the service-agreement lines.

If you copy lines into the service agreement from another service agreement, you can indicate whether you also want to

copy service object and service task relations. If you copy these relations, they are added to any existing relations on the

service agreement. If you copy service-agreement lines from a service template, the service-object and service-task

relations are automatically copied as service-object relations and service-task relations on the new service-agreement

lines.

1. From the Ser vice agreementsSer vice agreements  page, add a service agreement line in the lines grid.

2. Enter the appropriate information for the service agreement line.

3. Select SaveSave to save the line, and then close the page.

1. Select Project management and accountingProject management and accounting.

2. Select All projectsAll projects .

3. Select the project from the list.

4. On the Action PaneAction Pane, select ManageManage. In the NewNew  Action group, select Ser viceSer vice and select Ser viceSer vice

agreementagreement.

5. Follow the steps in the section titled Create a ser vice agreementCreate a ser vice agreement as described earlier in this topic to enter

the project reference.

Develop and establish service agreements overview
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Subscriptions are based on a time-and-materials project. You can create subscriptions from a project, from the

Ser vice subscr iptionsSer vice subscr iptions  page, or by using a service subscription group.

For each subscription, you can create an optional number of subscription fees. The subscription fees are the

transactions that you invoice to the customer.

A period code indicates the extent of the subscription fee period, or the intervals at which the subscription

should be invoiced.

The period code is defined in the service subscription group. It is defined for the subscriptions through the

service subscription group. Any new subscription fee that you create has a suggested start date. This is the start

date of the period, if it is the first period that is created, or the end of the previous period, if it is the second or

later period.
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Example

Create a template
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Copy template lines
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You can define a service agreement as a template and copy the lines of the template later into another service

agreement or into a service order.

A customer for whom you provide service has identical service elevators at five different locations.

You want to set up five service agreements for the customer, one for each site. To limit repetitive setup work, and

to make sure that the setup information in the service agreements is identical, you create a service agreement

and specify it as a template for the service work on the elevators.

You can now copy the template lines into the five new service agreements, so that each service agreement is

populated with the lines from the template.

When you create a service template, you create a service agreement, create the required lines on it, and attach

the service agreement to a service-template group.

A service agreement can be defined as a template only if it has no service orders attached to it. Also, no service orders

can be generated from a service agreement that is defined as a template.

You can copy template lines from a service template into another service agreement or into a service order.

When you copy template lines into your service orders or service agreements, your template groups are

displayed in a tree view in which each group can be expanded. This display lets you view each template and

template line.

It is easier to determine the service-template lines that you want to copy if you have grouped the templates

under names that reflect the use of the templates.

Copy service templates lines
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Copy service template lines into a service agreement

Copy service template lines into a service order
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Template information can be copied to either a service agreement or a service order.

1. Click Ser vice agreementsSer vice agreements .

2. Double-click a service agreement to open the Ser vice agreementsSer vice agreements  page.

3. Click Template linesTemplate lines  to open the Copy ser vice template linesCopy ser vice template lines  page.

4. On the Tree controlTree control  tab, expand the tree, find the template that contains the lines that you want to copy to

the service agreement, and then select the service template.

5. On the L inesLines  tab, select the SelectSelect check box for the service template lines that you want to copy.

6. Click OKOK.

7. Close the pages to save your changes.

The service template lines are now copied to the service agreement, together with the attached service object

and service task relations.

1. Click Ser vice ordersSer vice orders .

2. Double-click a service order to open the Ser vice ordersSer vice orders  page.

3. Click Copy > Copy template lines to open the Copy ser vice template linesCopy ser vice template lines  page.

4. On the Tree controlTree control  tab, expand the tree, find the template that contains the lines that you want to copy to

the service order, and then select the service template.

5. On the L inesLines  tab, select the SelectSelect check box for the service template lines that you want to copy.

6. Click OKOK.

7. Close the pages to save your changes.

The service template lines are now copied to the new service order, together with the attached service object

and service task relations.

Service templates
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Follow these steps to move a service order to the next stage in the service workflow or revert it to a previous

stage.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders .

2. Select the service order, and then click the DispatchDispatch tab.

3. On the Action PaneAction Pane, click either Next stageNext stage or Previous stagePrevious stage.

4. In the Change ser vice stageChange ser vice stage form, select the appropriate stage.
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Attach a template BOM to a service object

Delete a service BOM from a service object

Move the service BOM history from one service agreement to
another

Modify the information displayed for a BOM line

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice agreementsSer vice agreements  > Ser vice agreementsSer vice agreements .

2. Double-click the service agreement in which you want to attach a template BOM to an object relation.

3. Click SetupSetup > Ser vice objectsSer vice objects .

4. In the Ser vice objectsSer vice objects  form, select the object to attach a template BOM to, and then click FunctionsFunctions  >

Attach template BOMAttach template BOM.

5. In the Select template BOMSelect template BOM dialog box, select a template BOM, and then click OKOK.

6. Close the forms to save your changes.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice agreementsSer vice agreements  > Ser vice agreementsSer vice agreements .

2. Double-click the service agreement in which you want to delete a service BOM from an object relation.

3. Click SetupSetup > Ser vice objectsSer vice objects .

4. In the Ser vice objectsSer vice objects  form, select the object that has the service BOM to delete, and then click

FunctionsFunctions  > Delete ser vice BOMDelete ser vice BOM.

5. Close the forms to save your changes.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice agreementsSer vice agreements  > Ser vice agreementsSer vice agreements .

2. Double-click the service agreement to move a service BOM from.

3. Click SetupSetup > Ser vice objectsSer vice objects .

4. In the Ser vice objectsSer vice objects  form, select the object that has the service BOM to move, and then click

FunctionsFunctions  > Move ser vice BOMMove ser vice BOM.

5. In the Select ser vice object relationSelect ser vice object relation form, select the service object relation to move the service BOM

to, and then click OKOK.

6. Close the forms to save your changes.

1. Click Ser vice managementSer vice management > SetupSetup > Ser vice objectsSer vice objects  > Template BOMsTemplate BOMs.

2. Select a template BOM, and then click DesignerDesigner .

3. Click the SetupSetup tab. In the BOMBOM area, select the check boxes for the information to display on the BOM

lines of your service BOMs and template BOMs.
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4. Close the forms to save your changes.

Delete a service BOM
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1. Click Ser vice managementSer vice management > CommonCommon > Ser vice agreementsSer vice agreements  > Ser vice agreementsSer vice agreements . Select the

service agreement that you want to delete a service bill of materials (BOM) from.

2. On the Action PaneAction Pane, click Ser vice objectsSer vice objects .

3. In the Ser vice objectsSer vice objects  form, select the service object that you want to delete a service BOM from. Click

FunctionsFunctions , and then select Delete ser vice BOMDelete ser vice BOM.

4. Click YesYes .

If you have not applied a template BOM, the service BOM can be deleted from the Template BOMsTemplate BOMs form. If you have

applied a template BOM, the service BOM cannot be deleted by using this method.

Template BOMs

Manage template BOMs on object relations
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You set up the index for a subscription sales price when you create a subscription fee.

In the Create subscr iption feeCreate subscr iption fee form, set the Get pr icing fromGet pr icing from field to Indexed base pr iceIndexed base pr ice, and then

multiply the base price by the percentage in the Percent pr ice changePercent pr ice change field to get the sales price of the

subscription transaction.

For example, if the base price is EUR 1,000, and the index is 110, the sales price is EUR 1,100.

Create subscription fee transactions
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Reduce the days on a subscription fee

Example
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To reduce the number of days of an existing subscription fee, you can create a new transaction in which you

remove the period of time that should no longer be part of the subscription fee interval.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice subscr iptionsSer vice subscr iptions  > All ser vice subscr iptionsAll ser vice subscr iptions .

Select the service subscription, and on the Action Pane, click Subscr iption feesSubscr iption fees

2. In the Subscr iption typeSubscr iption type field, select Reduction daysReduction days .

3. Use the From dateFrom date field and the To dateTo date fields to define the date interval of the subscription fee that you

want to remove from the subscription fee period, and then click OKOK.

To view the transaction that was created, in the Subscr iptionSubscr iption form, click Fee transactionsFee transactions .

If a subscription transaction period runs from January 1 to January 31, and you want to reduce the period by 10

days, create a new transaction in which the reduction period is January 1 to January 10. (The reduction period

could also be January 5 to January 15, or any other ten day period).

Also, if the From dateFrom date on the reduction period is January 21 (31 minus 10), you could set the To dateTo date to any

date after January 31, and 10 days will still be removed from the fee transaction period.

Reduction days example
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You have created a subscription transaction for a customer's maintenance subscription, as described in the

following table.

F RO MF RO M
DAT EDAT E

TOTO
DAT EDAT E

SUB SCSUB SC
RIP T IORIP T IO
NN

SUB SCSUB SC
RIP T IORIP T IO
N  T Y P EN  T Y P E

P RO JECP RO JEC
TT

C AT EGC AT EG
O RYO RY

SA L ESSA L ES
C URREC URRE
N C YN C Y

SA L ESSA L ES
P RIC EP RIC E

March
01,
2011

March
31,
2011

NR-2 RegulaRegula
rr

9013 SubCat
2

EUR 200.00

The customer reports that it does not need service coverage for two days (March 10 and March 11). You agree

to reduce the subscription by these two days.

You create a new transaction of the Reduction daysReduction days  type, as described in the following table.

F RO MF RO M
DAT EDAT E

TOTO
DAT EDAT E

SUB SCSUB SC
RIP T IORIP T IO
NN

SUB SCSUB SC
RIP T IORIP T IO
N  T Y P EN  T Y P E

P RO JECP RO JEC
TT

C AT EGC AT EG
O RYO RY

SA L ESSA L ES
C URREC URRE
N C YN C Y

SA L ESSA L ES
P RIC EP RIC E

March
10,
2011

March
11,
2011

NR-2 ReductReduct
ionion
daysdays

9013 SubCat
2

EUR -12.90

When the transactions for March 2011 are invoiced, the sales price of EUR 200 is reduced by EUR 12.90. The

chargeable amount for the subscription transaction is therefore EUR 187.10, and two transactions are invoiced

at a total of EUR 187.10.

Reduce the days on subscription fees
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1. Click Ser vice managementSer vice management > CommonCommon > Ser vice subscr iptionsSer vice subscr iptions  > All ser vice subscr iptionsAll ser vice subscr iptions .

2. Select the subscription to update the index or base price for.

3. Click IndexIndex. In the ChangeChange field, indicate how to update the base price or index, and whether the update

must use a percentage or a new value. You can select from the following options:

Index by a percentageIndex by a percentage

Index toIndex to

Base pr ice by percentageBase pr ice by percentage

Base pr ice toBase pr ice to

4. Click OKOK.

The base price or index of the subscription is updated with the specified value.

Index subscription (class form)
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Forms for the Fulfill service contracts business process components

NOTENOTE

This topic provides an overview of the tasks to fulfill service agreements. The topic also lists the forms that are

associated with each business process component and discusses the tasks that are associated with each

business process component.

The following table lists the forms that support the Fulfill service contracts business process components. The

table entries are organized first by task, and then alphabetically by the name of the form.

To open some of the forms in the following table, you must enter information or parameter settings.

B USIN ESS P RO C ESS C O M P O N EN TB USIN ESS P RO C ESS C O M P O N EN T
TA SKTA SK F O RM  N A M EF O RM  N A M E USA GEUSA GE

Develop and establish agreement Ser vice agreementsSer vice agreements Create and maintain service
agreements.

SubscriptionSubscription Create and maintain service
subscriptions.

   

Monitor and implement
agreement

Change ser vice stageChange ser vice stage Select the next stage in the
workflow for a service order.

Ser vice ordersSer vice orders Create and maintain service
orders.

   

Update and evaluate contract Cancel ser vice levelCancel ser vice level
agreementagreement

Cancel the service level agreement
on a service order.

Cancel ser vice ordersCancel ser vice orders Cancel service orders, or reverse
the Canceled status of service
orders.

Index subscriptionIndex subscription Update the base prices and
indexes for subscriptions.
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Start and stop time recording on a service order
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Start time recording

Stop time recording

NOTENOTE

See also

NOTENOTE

Use this procedure to start and stop time recording for a service order for which a service level agreement is

defined.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders .

2. Click the Ser vice orderSer vice order  tab. On the Action PaneAction Pane, in the Ser vice level agreementSer vice level agreement group, click Star tStar t.

3. Enter the date and time that the time recording should be started.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders .

2. Click the Ser vice orderSer vice order  tab. On the Action PaneAction Pane, in the Ser vice level agreementSer vice level agreement group, click StopStop.

3. Enter the date and time that the time recording should be stopped.

4. Select Add a revocation reasonAdd a revocation reason, and select a reason code in the Stage reason codeStage reason code list to provide a

reason for stopping the time recording.

If Reason code on exceeding timeReason code on exceeding time is selected in the Ser vice management parametersSer vice management parameters  form, you must provide a

reason code before you can stop the time recording.

Start SLA time recording (form)

Stop SLA time recording (form)

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/service-management/start-and-stop-time-recording-on-a-service-order.md
https://technet.microsoft.com/library/hh242297(v=ax.60)
https://technet.microsoft.com/library/hh242241(v=ax.60)
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


View the start time and duration of a service order
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View the start time for a service order

View the time remaining to complete a service order

View the start time and stop time recording entries for a service order

See also
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You can view when the work on the service order was started and when the service order is going to be

completed.

You can also view when the time recording for a service order was started and stopped. When a service order is

stopped, the time at which the service order must be completed is postponed.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders . Select and double-click

an order to open the details form.

2. On the GeneralGeneral  tab, view the time that the work was started for a service order in the Star t timeStar t time field.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders . Select and double-click

an order to open the details form.

2. On the GeneralGeneral  tab, view the time remaining to complete a service order in the Latest completionLatest completion

timetime field.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders . Select and double-click

an order to open the details form.

2. On the Action PaneAction Pane, click the DispatchDispatch tab > Time recordingTime recording to open the SL A time recordingSL A time recording form

and view the time recording entries for the service order.

Service orders (form)
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See also
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View and modify the list of stage reasons for a service order. Use stage reasons to indicate the reason for the

status of a service order. For example, you can create a CanceledCanceled stage that is assigned a reason code of

Canceled by the customerCanceled by the customer .

Click Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders . Open a service order.

In the Ser vice ordersSer vice orders  form, on the Action PaneAction Pane, on the DispatchDispatch tab, click Stage reasonsStage reasons .

On the Stage reasonsStage reasons  form, click NewNew  to create a new stage reason code.

Stage reasons (form)
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View compliance with a service level agreement

TIPTIP

See also

NOTENOTE

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders . Select a service order

and double-click to open the details form for the order.

2. On the GeneralGeneral  tab, in the ComplianceCompliance field, view the percentage of time that was spent on the service

order compared to the time frame specified in the service level agreement.

If the value in the ComplianceCompliance field is larger than 100, the time limit of the service level agreement has been exceeded.

Service level agreements overview
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Create and use return reason codes and disposition codes to support the process for returning products.

Use a return reason code to describe the reason that the customer wants to return an item. You can assign a

reason code in the Create return ordersCreate return orders  form.

Assign a disposition code when an item is received or during the physical inspection of a returned item. You can

use disposition codes to describe the condition of the item. You can also use disposition codes to indicate

whether additional action is required for the transaction. For example, create disposition codes for the following

actions:

Scrap the returned item and provide a replacement item to the customer.

Return the item to inventory and credit the customer for the cost of the item.

Repair the item and return it to the customer.

Set up return reason codes

Set up disposition codes
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Method 1: Manually enter the return cost price

Method 2: Automatically generate the cost price based on the
customer invoice line

The cost of products that are returned to inventory is calculated by using the current cost of the products.

However, you might want the cost of the returned products to equal the cost of the products at the time when

you sold the products to the customer. You can do this by using the Return lot IDReturn lot ID field on the L ine detailsL ine details

FastTab in the Sales orderSales order  form.

For example, consider the following scenario. You invoice a customer. Then, the customer returns the delivered

products to you. You return the products to stock. In this case, when you credit the customer for the returned

products, the cost of those products is calculated by using the current cost of the products. However, if you use

the Return lot IDReturn lot ID field, the cost of the returned products is calculated by using the cost on the invoice of the

original sale to the customer.

To use a cost other than the current cost for returns from a customer, use one of the following methods.

By default, when you add items to a return order, the items are returned to inventory at the current cost price. To

specify a different return cost price, follow these steps.

1. Click Sales and marketingSales and marketing > CommonCommon > Return ordersReturn orders  > All return ordersAll return orders .

2. On the Action PaneAction Pane, in the NewNew  group, click Return orderReturn order .

3. In the Create return orderCreate return order  form, select a customer account, and then click OKOK.

4. In the Return order - RMA number : %1, %2Return order - RMA number : %1, %2  form, select an item, and then enter a negative quantity

in the QuantityQuantity  field.

5. Click the L ine detailsL ine details  FastTab.

6. On the GeneralGeneral  tab, enter a value in the Return cost pr iceReturn cost pr ice field. This value is used when the goods are

returned to inventory. If you do not enter a value, the current cost price is used when the goods are

returned to inventory.

This is the preferred method to use to create return lines. To use the cost of the products at the time when you

sold the products to the customer, create a return order and specify a sales line to return.

1. Click Sales and marketingSales and marketing > CommonCommon > Return ordersReturn orders  > All return ordersAll return orders .

2. On the Action PaneAction Pane, in the NewNew  group, click Return orderReturn order .

3. In the Create return orderCreate return order  form, select a customer account, and then click OKOK.

4. In the Return order - RMA number : %1, %2Return order - RMA number : %1, %2  form, on the Action PaneAction Pane, click Find sales orderFind sales order .

5. In the Find sales orderFind sales order  form, select the invoice line to return, and then click OKOK.

On the L ine detailsL ine details  FastTab, on the GeneralGeneral  tab, the Return lot IDReturn lot ID field displays the value from the

original sales line. Additionally, the Return cost pr iceReturn cost pr ice field displays the cost value from the original sales

line.
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Cost calculation example
When you use the Return lot IDReturn lot ID field on a return order line to specify the return cost price, the cost on the

return order line is used. If you run the inventory close or recalculation functionality, the cost is adjusted on the

original sales line. The cost on the return order line is automatically adjusted to reflect the same cost per piece.

1. Create and release a product that is named Test. In the Released product detailsReleased product details  form, specify the

following information:

a. On the Manage costsManage costs  FastTab, in the Item groupItem group field, select the Par tsPar ts  group.

b. On the GeneralGeneral  FastTab, in the Item model groupItem model group field, select DEFDEF .

c. On the PurchasePurchase FastTab, in the Pr icePrice field, type 10.00 as the cost price of the item.

d. On the Action PaneAction Pane, click Dimension groupsDimension groups . In the Storage dimension groupStorage dimension group field, select

S ite and Warehouse onlySite and Warehouse only . In the Tracking dimension groupTracking dimension group field, select No active trackingNo active tracking

dimensionsdimensions .

2. Create a purchase order for 10 pieces of the Test item at 6.00 per piece, and then post an invoice for the

purchase order.

Create a second purchase order for 10 pieces of the Test item at 8.00 per piece, and then post an invoice

for the purchase order.

3. Post an invoice for a sales order to sell five pieces of the Test item.

In this case, the sales order line is costed at 35.00 (5 pieces * 7.00 average cost per piece).

4. Create a return order for the customer. In the Find sales orderFind sales order  form, select the invoice line, and then

click OKOK.

5. In the Return order - RMA number : %1, %2Return order - RMA number : %1, %2  form, verify that a return order is generated to return the

Test item. The quantity of the return order is set to -5.00.

The Return lot IDReturn lot ID field displays a lot ID. This lot ID is taken from the original sales order of the item that

was sold to the customer. The Return cost pr iceReturn cost pr ice field displays the cost price from the original sales line.

6. Register the receipt of the returned items.

7. Post a packing slip for the returned items.

8. Post an invoice for the return order. On the All sales ordersAll sales orders  list page, select a sales order for which

Returned orderReturned order  is the order type.

9. Open the Inventor y transactionsInventor y transactions  form. Verify that the return is costed at 7.00 per piece by using the

value in the Return cost pr iceReturn cost pr ice field, for a total of 35.00 in the Cost amountCost amount field. You can open the

Inventor y transactionsInventor y transactions  form from the Return order - RMA number : %1, %2Return order - RMA number : %1, %2  form. In the L inesLines

grid, click Inventor yInventor y  > TransactionsTransactions .

10. In Inventory and warehouse management, use the Closing and adjustmentClosing and adjustment form to run the 3. Close3. Close

procedure.

This action adjusts the cost on the original sales line that was costed at -35.00 (5 pieces * 7.00) to -30.00

(5 pieces * 6.00). This is because the inventory model group uses First in, First out (FIFO), and 6.00 per

piece is the FIFO cost from the first purchase order. Additionally, the action adjusts the cost on the return

sales line to match the cost per piece on the original sales line. Therefore, the cost of the return line is

adjusted from 35.00 to 30.00.
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You can cancel a return order, instead of deleting it, when you want to save a record of the planned return.

Only return orders that have a CreatedCreated status can be canceled. Return orders with an OpenOpen or ClosedClosed status cannot be

canceled.

1. Click Sales and marketingSales and marketing > CommonCommon > Return ordersReturn orders  > All return ordersAll return orders .

–or–

Click Sales and marketingSales and marketing > CommonCommon > Return ordersReturn orders  > Created return ordersCreated return orders .

2. Select the return order to cancel.

3. Click Cancel orderCancel order .
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Create a replacement order after you receive an item that is returned

Create a replacement order before you receive an item that will be
returned

Item replacement orders are usually created after a product is returned and inspected. However, when an item

must be replaced before it has been returned, or when the original item will not be returned, you can create an

item replacement order immediately after you create a return order.

1. Click Sales and marketingSales and marketing > CommonCommon > Return ordersReturn orders  > All return ordersAll return orders .

2. Create a new return order, or select a returned order from the list to open the Return order - RMAReturn order - RMA

number : %1, %2number : %1, %2  form.

3. Click Return lineReturn line, and then select Replacement itemReplacement item .

4. Select the item to replace the returned item with. Enter the item specifications, and then click ApplyApply .

5. Click Packing slipPacking slip to generate the packing slip for the return order. A sales order is generated for the

replacement item that you selected.

After the sales order is created for the replacement item, sales agreements are automatically searched

and if there is an applicable sales agreement, it is applied to the sales order.

1. Click Sales and marketingSales and marketing > CommonCommon > Return ordersReturn orders  > All return ordersAll return orders .

2. Create a new return order, or select a return order from the list to open the Return order - RMAReturn order - RMA

number : %1, %2number : %1, %2  form.

3. Click Find sales orderFind sales order  if you want to identify the sales order for the returned item. Complete the FindFind

sales ordersales order  form and then click OKOK to close the form and return to the Return order - RMA number :Return order - RMA number :

%1, %2%1, %2  form. The sales order line for the returned item is copied to the return order.

4. Click Replacement orderReplacement order  to open the Create sales orderCreate sales order  form.

5. Select the Copy return order linesCopy return order lines  check box to transfer details from the return order you selected on

the Return order - RMA number : %1, %2Return order - RMA number : %1, %2  form to this sales order.

6. Enter or modify details, as required.

If you identified the sales order in step 3, and if the sales order line for the returned item is linked to a

sales agreement, the identifier of the applicable sales agreement for the item replacement order will be

automatically displayed in the Sales agreement IDSales agreement ID field.

7. Click OKOK to close the Create sales orderCreate sales order  form and open the Sales orderSales order  form, where you can continue

to enter information for the new sales order. Any applicable return order lines will be copied to the new

sales order.

If the identifier of the sales agreement is automatically displayed in the Sales agreement IDSales agreement ID field, then

the sales agreement has been linked to the sales order header for the item replacement order. If there is

an applicable commitment in the sales agreement that has not been fulfilled yet, and the sales order is
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created before the sales agreement expires, a link is established between the sales agreement line and the

sales order line. Therefore, information from the sales agreement, such as item price, is copied to the new

sales order line.
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Use the Delete return orderDelete return order  form to delete multiple return orders.

1. Click Sales and marketingSales and marketing > PeriodicPeriodic > Clean upClean up > Delete return ordersDelete return orders .

2. Click SelectSelect to open the Sales updateSales update form.

3. Specify the criteria, and then click OKOK to return to the Delete return orderDelete return order  form. Return orders that

have been created in the legal entity are displayed, based on the specified criteria.

4. Select the return order line to delete, and then click OKOK.

5. Click YesYes  to delete the return orders.
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See also
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When registering a returned item, you may determine that an item should be sent for inspection before it is

returned to inventory or disposed of in some other way.

NOTENOTE

1. Click Inventor y managementInventor y management > JournalsJournals  > Item arr ivalItem arr ival  > Item arr ivalItem arr ival .

-or-

Click Inventor y managementInventor y management > JournalsJournals  > Item arr ivalItem arr ival  > Production inputProduction input.

2. On the Location journalLocation journal  form, register the receipt of an item as usual.

For information about registering the receipt of returned items, see Register the receipt of returned items

3. On the Default valuesDefault values  tab, in the Mode of handlingMode of handling area, select the Quarantine managementQuarantine management box.

This will prompt the system to create a quarantine order, and the person or department that performs

inspections will respond to this order using the Quarantine orderQuarantine order  form.

Take returned items through inspection

Specify how to dispose of returned items
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To process a return, first validate the return quantity, update the quantity field in the item arrival journal. Then

select a disposition code or indicate that the returned items have to be inspected. After completing these steps,

you can post the item arrival journal for the return order.

TIPTIP

1. Click Inventor y managementInventor y management > PeriodicPeriodic > Arr ival over viewArr ival over view .

2. In the Setup nameSetup name filter, select Return orderReturn order .

3. If the list of receipts is long, use the fields in the RangeRange area to narrow the list.

4. Locate the line of the return order that you want to post, select its Select for arr ivalSelect for arr ival  box, and then click

Star t arr ivalStar t arr ival .

5. Click JournalsJournals  > Show arr ivals from receiptsShow arr ivals from receipts  to open the Location journalLocation journal  form.

To view detailed information, select a journal, and then click LinesLines .

6. Make any necessary updates, and then click PostPost.

After the journal is posted, the returned items are registered in inventory, and the Return ordersReturn orders  form indicates

that the items have arrived at the warehouse.

Location journal (form)
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Register and post a partial quantity

NOTENOTE

Partial deliveries are defined in terms of return order lines, not return order shipments.

This means that if you receive the full quantity that is indicated on one return order line, but you receive nothing

from the other lines in the return order, the delivery is not a partial delivery. However, if a return order line

requires 10 units of a particular item to be returned, but you receive only four, it is a partial delivery.

If a return shipment contains less than the full quantity of a return order line, you can set the shipment aside and

wait for the rest of the returned quantity to arrive, or you can register and post the partial quantity.

1. After you select a return order for arrival on the Arr ival over view - Warehouse: %1, Dock : %2,Arr ival over view - Warehouse: %1, Dock : %2,

Journal name: %3Journal name: %3  form, click Star t arr ivalStar t arr ival  to create the arrival journal, and then click JournalsJournals  >

Show arr ivals from receiptsShow arr ivals from receipts  to open the Location journalLocation journal  form.

2. Select the line of the journal that you want to work with, and then click L inesLines  to open the Journal lines,Journal lines,

locationslocations  form.

3. Select the line of the item number for which only a partial quantity has arrived, and then click FunctionsFunctions

> SplitSplit to open the SplitSplit form.

4. In the Split quantitySplit quantity  field, enter the quantity for the total number of items that have been received, and

then click OKOK.

5. On the Journal lines, locationsJournal lines, locations  form, select the line for the quantity of items that has arrived, and then

click PostPost. You can post the line for the additional quantity after the items have arrived.
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When a return shipment arrives, you match it to a return order that has already been created.

Depending on company policies, the items in the return shipment can be sent to quarantine for additional

inspection or they can be returned to inventory.

Register the receipt of returned items

Post arrival journal for returned products

Take returned items through inspection
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Register the receipt of returned items in the Arrival overview form

There are two methods for registering the receipt of returned items. The first method is a warehouse receiving

process that uses the Arr ival over viewArr ival over view  form. The second uses the RegistrationRegistration form.

You can use the Arr ival over viewArr ival over view  form to identify a return shipment by its Return Material Authorization

(RMA) number. If a journal name is defined on the SetupSetup tab, and journal lines that correspond to the lines

selected on the Arr ival over viewArr ival over view  form exist, a new journal header is created when you click Star t arr ivalStar t arr ival .

TIPTIP

WARNINGWARNING

NOTENOTE

NOTENOTE

1. Click Inventor y managementInventor y management > PeriodicPeriodic > Arr ival over viewArr ival over view .

2. In the Setup nameSetup name field, select Return orderReturn order , and then click UpdateUpdate.

You can use the RangeRange fields to narrow the search results. You can type or select the RMA number in the RMARMA

numbernumber  field for an exact result. To define and save a set of filters that will restrict which incoming arrivals are

displayed, click the SetupSetup tab. The available filters include types, warehouses, and docks.

Return orders cannot be mixed with other arrival types in the Arrival over viewArrival over view form. Therefore, the reference will

always be sales order, but no sales order ID will be specified on the journal header.

3. In the ReceiptsReceipts  grid, locate the line that matches the item being returned, and then select the check box

in the Select for arr ivalSelect for arr ival  column.

4. To exclude certain lines from the return receipt, such as items from the original order that were not

included in the return shipment, clear the associated Select for arr ivalSelect for arr ival  check boxes in the L inesLines  table in

the lower part of the form.

5. Click the Star t arr ivalStar t arr ival  button to create an arrival journal.

You can select multiple return orders and include them all in a single arrival process. Each return order line will be

copied into a corresponding item arrival journal line.

You can also manually create an arrival journal by using the Item arrivalItem arrival form.

6. Click Inventor y managementInventor y management > JournalsJournals  > Item arr ivalItem arr ival  > Item arr ivalItem arr ival .

7. Select the arrival journal that you just created and then click L inesLines  to open the Journal lines, locationsJournal lines, locations

form.
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8. On the GeneralGeneral  tab, adjust the number in the QuantityQuantity  field, if it is required, and then assign a

disposition code in the Disposition codeDisposition code field.

Alternatively, you can select the Quarantine managementQuarantine management check box to have the returned items sent

through an inspection process in the context of a quarantine order.

If you send the returned items through quarantine, you cannot specify a disposition code.

9. Click the ValidateValidate button.

10. If there are no errors in the validation process, click PostPost.

As an alternative to using the Arr ival over viewArr ival over view  form, you can use the RegistrationRegistration form to register the arrival

of returned items.

NOTENOTE

1. Click Sales and marketingSales and marketing > CommonCommon > Return ordersReturn orders  > All return ordersAll return orders . Create a new return

order or open the return order from the list. On the L inesLines  FastTab, select the return order line. Click

Update lineUpdate line, and then click RegistrationRegistration.

2. Assign a disposition code in the Disposition codeDisposition code field, and then click OKOK.

It is not possible to send the item for inspection as a quarantine order using the RegistrationRegistration form.

3. In the TransactionsTransactions  grid, select the transaction to be registered.

4. In the Register nowRegister now  grid, click AddAdd. Repeat the previous two steps until all of the returned items appear

in the Register nowRegister now  grid.

5. Click Post allPost all .

Arrival overview (form)
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1. Click Inventor y managementInventor y management > PeriodicPeriodic > Quality managementQuality management > Quarantine ordersQuarantine orders .

2. Locate the order line that corresponds to the returned item that you are inspecting.

A quarantine order can be associated with just a single item number. If 10 items that have different item numbers

are returned in a single shipment and sent to quarantine, 10 individual quarantine orders are created.

3. After examining the item, make a selection in the Disposition codeDisposition code field to indicate what should be

done with the item and how to handle the related financial transaction. Examples include returning the

item to stock and refunding the customer, scrapping the item and sending a replacement to the customer,

or returning the item to the customer without credit.

If multiple returned items in a single item number batch cannot be assigned the same disposition code, you must

split the quarantine order (FunctionsFunctions > SplitSplit ) to assign a different disposition code to each sub-batch.

4. When you are finished with the inspection, click Repor t as finishedRepor t as finished to release the returned items and

create an item arrival journal entry. The person or department that receives the items then processes the

journal for the items to be returned to inventory.

–or–

End the quarantine order, and move the items back into inventory directly by using one of the Inventor yInventor y

functions.

5. Close the form to save your changes.

Specify how to dispose of returned items
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Before returned items can be received into inventory, the packing slip for the order to which they belong must

be updated. Just as the invoice update process is the update to the financial transaction, the packing slip update

process is the physical update of the inventory record, which means that it commits the changes to inventory. In

the case of returns, the steps that are assigned to the disposition action are implemented during the packing slip

update.

The packing slip update can be processed in either the item arrival journal or the return order.

As part of the process for posting packing slips, the packing slip reference number from the customer’s shipping

documents can be associated with the order lines. This association is optional and for reference only. It does not

create any transactional updates.

If not all of the expected return items have arrived, you should include only the quantity that has been received

in the packing slip update. Leave the remaining items on the order until the rest of the return shipment has

arrived.

If an item is sent back from quarantine to the Shipping and Receiving department, such as when the quarantine

inspector does not know where to store the item in inventory, the corresponding packing slip must be updated

to correctly register and act on the disposition code that is specified as a result of the quarantine.

When you update a packing slip for a returned item that is from a sales agreement, the sales agreement

commitment for that item is automatically updated to reflect the change in the quantity or the amount.

Perform invoice updates for returns
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Post an invoice for a return order
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A return order is a type of sales order that is marked as a returned order. Therefore, the All sales ordersAll sales orders  list

page is used to generate invoices for return orders instead of the Return ordersReturn orders  form. This functionality

supports the business processes of organizations that choose to have return orders and sales orders invoiced at

the same time and by the same person.

Because the invoice for a returned item is for a negative amount, it is called a credit note.

When you set up the invoice update for batch processing, the sales order of type Returned orderReturned order  must have a

return line status of ReceivedReceived, which indicates that the order's packing slip has been updated.

1. Click Accounts receivableAccounts receivable > CommonCommon > Sales ordersSales orders  > All sales ordersAll sales orders .

2. Select a sales order for which Returned orderReturned order  is displayed in the Order typeOrder type field.

3. On the Action Pane, on the InvoiceInvoice tab, in the GenerateGenerate group, click InvoiceInvoice.

4. On the ParametersParameters  tab, select the PostingPosting check box.

5. Review information in the form and make any changes that are needed.

6. Click OKOK. The credit note is posted.

Packing slip updates for returns
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Create service orders
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Monitor the progress of service orders

A service order represents a visit that a service technician makes to a customer site on a specific date. Each

service order consists of one or more service order lines. Service order lines represent the hours of work that

must be performed by the service technician, and the related items, expenses, and fees.

You can attach tasks and objects to a service order line. You can then group service order lines by task or by

object. You can also attach items that are listed in inventory to service order lines.

You can create service orders based on a service agreement and the lines that are contained in that agreement.

However, you can create service orders that are associated with a service agreement only in the period that is

specified in the agreement. For example, if a service agreement is valid for the 2011 calendar year, you can

create service orders for the agreement from January 1, 2011, and December 31, 2011.

You can also create service orders individually, without associating them with an agreement. These service

orders can be used to handle unscheduled or one-time service visits. For example, in the month of March, your

customer wants service to be performed on two machines, in addition to the machines that are specified in the

service agreement. For this task, you create service orders but do not associate them with an agreement.

To create service orders that are not associated with a service agreement, you must select the Allow without ser viceAllow without ser vice

agreementagreement  check box in the Ser vice management parametersSer vice management parameters  form.

ScenarioScenario

The following scenario describes another situation where it is useful to create a service order that is not

associated with a service agreement.

The company dispatcher receives a call requesting emergency service on an elevator. There is no time to set up a

service agreement and a project for the service. Therefore, the dispatcher creates a service order directly in the

Ser vice ordersSer vice orders  form, attaches the service order to an existing project, and creates the service order lines. The

dispatcher also creates a task or object relation for an existing service order, to record work that is not related to

the service agreement. For more information, see Create service orders manually and Create service task

relations.

To monitor the progress of a sales order through the different teams and work processes, you can set up a

system of stages and reason codes for service orders. For each stage, you can specify the actions that are

allowed. For more information, see Create reason codes.

ExampleExample

A service order is approved by the dispatcher. The dispatcher updates the stage of the service order and

specifies a reason code that indicates that the service order has been released to the service technician. The

technician goes to the customer site and performs the service.
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You can specify the inventory items that are required for service orders. However, the service order must be

associated with a project. Item requirements for service orders are processed through a project.

ExampleExample

The service orders that are created from the service agreement are processed by the dispatcher. For the first

service order, the dispatcher realizes that the service technician requires an important spare part that is not in

the on-hand inventory. Therefore, the dispatcher creates an item requirement for the spare part directly from

the service order.

A service technician returns from a service visit, and then modifies and updates the service order lines. During

the service visit, the technician performed a service job that was scheduled for the next service visit. Therefore,

the technician moves the lines from the next service visit to the current service visit. The technician then posts

the service order. For more information, see Move service order lines.

One of the other service orders that was generated for the month of January becomes obsolete, because the job

is canceled. Therefore, the service dispatcher cancels the service order. For more information, see Cancel service

orders.

At the end of each week, the dispatcher wants to post all service orders that are attached to a specific project.

Therefore, the dispatcher locates the relevant project in the ProjectsProjects  form and posts the service orders that

have been completed. For more information, see Post service orders (class form).

During the second half of the year, your customer decides that the service visits are too infrequent. You must

create a new, more frequent series of service visits for the remaining time on the service agreement. Therefore,

you must delete the existing service orders and create new service orders. For more information, see Delete

service orders.

Service orders (form)
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Example 2
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You can generate service orders that are based on a service agreement for the valid period of the service

agreement.

The service orders that you generate from a service agreement are all attached to the service agreement.

Service orders are generated automatically from the following settings:

The service agreement interval that is set up in the service agreement lines. The service agreement

interval indicates the frequency that service-order lines are created. For more information, see Service

intervals.

The period that you specify to define the service period in the From dateFrom date and To dateTo date fields in the

Create ser vice ordersCreate ser vice orders  form. For more information, see Create service orders automatically.

The Combine ser vice ordersCombine ser vice orders  option on the service agreement header. This option defines whether

service order lines generated from a service agreement, combines service orders according to employee,

service task, service object, or service agreement. For more information, see Combine service orders.

The Time windowTime window  option on the service agreement line. The time window defines how far a service

order line can move with regard to its calculated date. For more information, see Time windows.

If the day that is specified for a service order is not open in the calendar that you have selected in the Ser viceSer vice

management parametersmanagement parameters  form, a message will indicate that there is a calendar conflict. You can safely ignore the

message; the service order will be created, even though the day is closed on the calendar.

The service agreement lasts from January 1, 2012 until December 31, 2012. If the service period that you

specify in the Create ser vice ordersCreate ser vice orders  form is from November 1, 2012 until February 1, 2013, service orders

are created from November 1, 2012 until December 31, 2012.

The service agreement lasts from January 1, 2012 until December 31, 2012. Two service agreement lines are

attached to the service agreement. The first service agreement line has a starting date on January 2, 2012 and

an ending date on March 1, 2012. The second service agreement line has a starting date on April 1, 2012 and an

ending date on December 31, 2012. You specify a period in the Create ser vice ordersCreate ser vice orders  form that is from

October 1, 2012 until December 31, 2012. Therefore, service orders are generated only for the second

agreement line, because the starting date and ending date of the first agreement line are before the period that

you specified for the service order.
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In the Ser vice ordersSer vice orders  form, the ProgressProgress  field on the service order header reflects the status of the whole

service order, and the StatusStatus  reports the status of individual service order lines.

P RO GRESSP RO GRESS L IN E 1 STAT USL IN E 1 STAT US L IN E 2 STAT USL IN E 2 STAT US L IN E 3 STAT USL IN E 3 STAT US

In processIn process CreatedCreated CreatedCreated CreatedCreated

In processIn process CanceledCanceled CreatedCreated CreatedCreated

In processIn process CreatedCreated CanceledCanceled PostedPosted

CanceledCanceled CanceledCanceled CanceledCanceled CanceledCanceled

PostedPosted PostedPosted PostedPosted PostedPosted

PostedPosted PostedPosted CanceledCanceled CanceledCanceled

The progress of a service order is in process if all lines have the status CreatedCreated; it is still in process if some of

the lines have a status of CanceledCanceled or PostedPosted.

If all lines in a service order are marked as PostedPosted, the progress of the status order is PostedPosted. If some lines are

PostedPosted and some are CanceledCanceled, the progress is still PostedPosted.
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Create service orders automatically for a service agreement

Create service orders automatically for several service agreements
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You can create service orders for one service agreement or for several service agreements. When they are

created, you can view your service orders in the Ser vice ordersSer vice orders  form.

Service orders are created only for the valid period of the service agreement. If the interval that you specify in

the Create ser vice ordersCreate ser vice orders  form is before the starting date or after the ending date of the service agreement,

service orders are created only for the part of the interval that is within the service agreement dates.

When you create service orders manually or automatically from the service agreement line, the service order

must be in the time interval that is defined by the starting and ending dates for the line, unless you do not

specify an ending date on the line.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice agreementsSer vice agreements  > Ser vice agreementsSer vice agreements .

2. Select a service agreement.

3. Click the DeliverDeliver  tab, and then click Planned ser vice ordersPlanned ser vice orders .

4. Specify dates in the From dateFrom date and To dateTo date fields to define the service period.

5. Select the Show InfologShow Infolog check box to display a list of the service orders that are created.

6. Select transaction types in the Include transaction typesInclude transaction types  field group. The transaction types represent

the lines that are created in the service agreement, and each transaction type that you select generates

several service orders, depending on the service interval that is specified on the service agreement line.

7. To create any service orders that are missing from continuous series of service orders, select the

ContinuousContinuous  check box.

8. Click OKOK.

1. Click Ser vice managementSer vice management > PeriodicPeriodic > Ser vice ordersSer vice orders  > Create ser vice ordersCreate ser vice orders .

2. Click SelectSelect to make selections to add or remove criteria to use to create service orders.

3. Click OKOK.

Service orders

Automatically create service orders
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Create an item requirement for a service order

Create an item requirement for a service agreement
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You can create a service order to track and manage services that you provide to your customers. If you need to

reserve specific items for a service order, you can create inventory item requirements for it. An item

requirement can be immediately consumed from inventory, or it can initiate a production order for the item.

By using an item requirement instead of an item transaction, you can plan for delivery just before the item is

actually used, create a purchase order, include the item in the trade-agreement framework, and include the item

requirement in production planning.

Item requirements for service orders are processed through a project. To create an item requirement on a

service order, the service order must be assigned to a project. After you create an item requirement for a service

order, you can view the item requirement in the ProjectsProjects  form for the selected project.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders .

2. Select the service order that you want to create an item requirement for.

3. On the Action PaneAction Pane, on the DispatchDispatch tab, click Item requirementItem requirement.

4. In the Item requirementsItem requirements  form, enter information for the required item. For more information about

the specific fields, see Item requirements (form).

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice agreementsSer vice agreements  > Ser vice agreementsSer vice agreements .

2. Open the service agreement for which you want to create an item requirement.

3. On the L inesLines  FastTab, click AddAdd to create a new line.

4. In the Transaction typeTransaction type field, select ItemItem.

5. In the Item setupItem setup field, select Item requirementItem requirement.

6. In the Item numberItem number  field, select the item that is required for the service agreement.

7. On the L ine detailsL ine details  FastTab, on the Product dimensionsProduct dimensions  tab, in the S iteSite field, select the inventory site

for the item.

8. To create a service order from the agreement line, on the L inesLines  FastTab, click Create ser vice ordersCreate ser vice orders ,

and then enter the relevant information in the Create ser vice ordersCreate ser vice orders  form.

Create service orders automatically.
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View an item requirement from a service order

Delete service orders with item requirements
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You can create a service order to track and manage services that you provide to your customers. If you need to

reserve specific items for a service order, you can create inventory item requirements for it. An item

requirement can be immediately consumed from inventory, or it can initiate a production order for the item.

By using an item requirement instead of an item transaction, you can plan for delivery just before the item is

actually used, create a purchase order, include the item in the trade-agreement framework, and include the item

requirement in production planning.

Item requirements for service orders are processed through a project. To create an item requirement on a

service order, the service order must be attached to a project.

As soon as an item requirement is created for a service order, it can be viewed from ProjectProject in the individual

service order or through the Sales orderSales order  form.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders .

2. Click DispatchDispatch, and then click Item requirementItem requirement to open the Item requirementsItem requirements  form.

3. Click the ProjectProject tab, and check the Ser vice orderSer vice order  field to see the service orders of the item

requirement.

If an item requirement is created on a service order, you cannot delete the service order. You must delete the

item requirement before you can delete the service order.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders .

2. Click DispatchDispatch, and then click Item requirementItem requirement to open the Item requirementsItem requirements  form. This form lists

the item requirements that are created on the service order.

3. Select the item requirement to delete, and then click DeleteDelete.

–or–

1. Click Project management and accountingProject management and accounting > CommonCommon > ProjectsProjects  > All projectsAll projects .

2. Open the project that has the service order in which an item requirement is created.

3. In the ProjectsProjects  form, in the right pane, click Item requirementsItem requirements . The Item requirementsItem requirements  form lists the

item requirements that are associated with the selected project.

4. Select the item requirement to delete, and then click DeleteDelete.

Item requirements (form)
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Setting up subscriptions

Create and modify subscription transactions

Invoice and accrue subscription transactions
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You are the subscriptions administrator for a light company that offers subscriptions for lighting rig

maintenance. A customer contacts your company to purchase a yearly subscription for lighting rig maintenance.

To set up a subscription, you must first create a subscription group for the new service agreement or verify that

a subscription group exists. If a subscription group exists, you must set it up to invoice the customer yearly and

to accrue sales revenue every month of the year. For more information about how to set up subscriptions, see

Set up subscription groups.

After the subscription group is created, you can create the subscription. For more information about how to

create service subscriptions, see Create service subscriptions from a subscription group.

After you set up the subscription, you create the subscription fee transaction for the first invoicing period, which

is one year. The transactions are of the RegularRegular  type. Therefore, you can only create subscription transactions

where the from date and the to date correspond to periods that were previously created in the Period typesPeriod types

form. For more information about fee transactions, see Create subscription fee transactions.

After you set up the subscription for your customer, you remember that they have negotiated a 10 percent

discount on all list prices for service offerings. Therefore, you must reduce the price of the transaction fee that

you created.

Later in the day, your customer contact calls to say that, although they still want the service agreement for the

lighting rig, they plan to introduce a new lighting rig later in the year. Therefore, they only need maintenance

coverage until October 2013. To reduce the number of months for the customer’s subscription, you create a new

subscription fee transaction of the Reduction daysReduction days  type. For more information about how to reduce days, see

Reduce the days on subscription fees.

You have now finished setting up the subscription, and you are ready to invoice your customer for it. For more

information about how to invoice subscriptions, see Invoice subscription transactions.

Two days later, your customer calls to say that the subscription should be invoiced in U.S. dollars, not Euros.

Therefore, you create a credit note, and you also create a new subscription transaction in the correct currency.

For more information about how to credit subscription transactions, see Credit subscription transactions.

At the end of each month, one month's revenue can be accrued from the customer's subscription to the profit

and loss account and the WIP accounts. For more information about how to accrue revenue for subscriptions,

see Accrue subscription revenue.
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Example

NOTENOTE

See also

When you create service order lines automatically in the Ser vice agreementsSer vice agreements  form, you can choose one of the

following options to specify how you want to group them:

By ser vice agreementBy ser vice agreement

By ser vice taskBy ser vice task

By employeeBy employee

By ser vice objectBy ser vice object

You create a service agreement that has a start date on 03-31-2007. In the Combine ser vice ordersCombine ser vice orders  field, you

specify By ser vice objectBy ser vice object. You then create the following service agreement lines:

A GREEM EN TA GREEM EN T
L IN EL IN E
N UM B ERN UM B ER

T RA N SA C T IT RA N SA C T I
O N  T Y P EO N  T Y P E

DESC RIP T IODESC RIP T IO
NN IN T ERVA LIN T ERVA L

SERVIC ESERVIC E
O B JEC TO B JEC T STA RT  DAT ESTA RT  DAT E

1 HourHour SAL1 Weekly X-1 04-01-2007

2 HourHour SAL2 Biweekly X-2 04-01-2007

3 HourHour SAL3 Weekly X-2 04-01-2007

You do not specify time windows for any of the service agreement lines. Therefore, the service order lines will

not move from the calculated day on which they fall.

Next, you generate service order lines from the Create ser vice ordersCreate ser vice orders  form from 04-01-2007 until 04-30-

2007.

In total, 10 service orders are created. Because the combined setting that you selected was By ser vice objectBy ser vice object,

all service orders that are created have only service order lines with one specific service object. Service order

lines that are generated from the service agreement and have the same service date and object are combined

on the same service order.

In this example, the calendar that is specified in the Ser vice management parametersSer vice management parameters  form has no closed days.

Additional grouping of service order lines into service orders occurs according to any time window that you

specify on the service agreement lines.

Create service orders automatically
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group
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1. Select Ser vice managementSer vice management > SetupSetup > Ser vice subscr iptionsSer vice subscr iptions  > Subscr iption groupsSubscr iption groups .

2. Select a subscription group.

3. Select the Ser vice subscr iptionsSer vice subscr iptions  button.

4. Select NewNew  to create a new subscription. The subscription group field displays information from the

subscription group in the Subscr iptionSubscr iption form.

5. Enter information in the remaining fields.

6. Close the form to save your changes.

Can you tell us about your documentation language preferences? Take a short survey.
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Project attached to service agreement
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You can attach service agreements to projects of every type except the Time projectTime project type.

You register and post all service order transactions through the project that you attach to the service agreement.

You specify the journals in which these transactions are registered and posted on the JournalsJournals  link in the

Ser vice management parametersSer vice management parameters  form.
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Create service subscriptions from a project
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See also
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You can create a service subscription from a project in Project management and accountingProject management and accounting.

1. Click Project management and accountingProject management and accounting > CommonCommon > ProjectsProjects  > All projectsAll projects . Open the project

that you want to create a subscription for.

2. On the ProjectsProjects  form, on the Action PaneAction Pane, on the ManageManage tab, click Ser viceSer vice > Ser vice subscr iptionSer vice subscr iption.

3. On the Subscr iptionSubscr iption form, in the Ser vice subscr iptionSer vice subscr iption field, enter a unique identification number. The

project number is entered automatically into the subscription for the selected project.

4. Enter the remaining information in the form.

You can now create subscription transactions for the subscription.

If you have set up a number sequence for the subscription group, a subscription ID is generated automatically for the

subscription when you specify the subscription group.

Subscription sales prices
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Service activities
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Create service activities to define and maintain tasks in a service order. A service order can include one or more

service activities to be performed by a worker.

Service activities are defined in the Activity typesActivity types  form. (Click Sales and marketingSales and marketing > SetupSetup > ActivitiesActivities  >

Activity typesActivity types .) After you set up activities, you can add them to service orders automatically based on the

related service agreement, or you can manually add activities when you add lines to a service order.

You can view the status of service activities in the Dispatch boardDispatch board form. You can also reassign activities from

one worker to another worker in that form.

Dispatch board (form)
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Dispatch board
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See also
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A dispatch board is the central location from which you can view the status of activities in a service order. You

can perform the following tasks in a dispatch board:

Filter and view service activities in a certain date range.

Identify the priority of a service activity, and distinguish among service priority levels based on a color

scheme that you set up.

Review the workers that are assigned to a dispatch team.

Modify the service times and assigned technicians for a service activity.

Review the list of service activities that have not been dispatched.

For information about how to perform specific tasks in a dispatch board, see the topics in the See alsoSee also section.

Set up service activity types

Set up a preferred technician
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See also
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1. Click Sales and marketingSales and marketing > SetupSetup > ActivitiesActivities  > Activity typesActivity types .

–or–

Click Organization administrationOrganization administration > SetupSetup > ActivitiesActivities  > Activity typesActivity types .

2. In the Activity typesActivity types  form, press CTRL + N to add a new activity type line.

3. In the TypeType field, enter a name for the activity type.

4. In the Descr iptionDescr iption field, enter text to describe this activity type.

5. Close the form to save your changes.

Activity types (form)

Dispatch board
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Set up a preferred technician
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Assign employee to a dispatch team

Assign a preferred technician to a service agreement

Assign a preferred technician to a service order

See also

NOTENOTE

You can select any worker as a preferred technician for a service agreement or service order. However, it is a

good idea to add the worker to the appropriate dispatch team so that the worker is included on the DispatchDispatch

boardboard.

1. Click Human resourcesHuman resources  > CommonCommon > WorkersWorkers  > WorkersWorkers . Double-click a worker to open the worker

details page. On the Action PaneAction Pane, click SetupSetup >Dispatch teamDispatch team to open the Dispatch workersDispatch workers  form.

2. In the Dispatch teamDispatch team field, select the team to assign the worker to.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice agreementsSer vice agreements  > Ser vice agreementsSer vice agreements . Double-

click a service agreement to open the details form.

2. On the GeneralGeneral  tab, select the Preferred technicianPreferred technician field, and then select a member of the appropriate

dispatch team as the preferred technician for the service agreement.

NOTENOTE

1. Click Ser vice managementSer vice management > PeriodicPeriodic > Dispatch boardDispatch board.

In the Dispatch boardDispatch board form, specify a date range for dispatch activities to view. Also, specify whether to display

closed activities and whether to limit the dispatch activity list to teams that you belong to or are authorized to

monitor. Click OKOK to open the Dispatch boardDispatch board.

2. Select the line of the service activity to modify.

3. On the RelatedRelated tab, use the WorkerWorker  list to assign a member of the appropriate dispatch team as the

preferred technician for the service call.

Develop and establish service agreements overview

Create service orders manually

Service agreements (form)
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This topic describes how to create a dispatch team. After you create a dispatch team, you can assign workers to

the team. When you create a service order, you can then relate a member of a dispatch team to an activity in the

service order.

NOTENOTE

1. Click Ser vice managementSer vice management > SetupSetup > Dispatch teamsDispatch teams .

2. In the Dispatch teamsDispatch teams form, click NewNew  to create a new team.

3. In the Dispatch teamDispatch team field, enter a unique name for the dispatch team.

4. In the OwnerOwner  field, select the employee who is responsible for this team.

You can select only employees in this field. You can’t select vendors.

5. Optional: In the Descr iptionDescr iption field, enter a brief description for this dispatch team.

You can assign a worker to this dispatch team in the WorkerWorker  form. For more information about how to assign a worker

to a dispatch team, see Dispatch workers (form).
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Prioritize service orders
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See also
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1. Click Ser vice managementSer vice management > PeriodicPeriodic > Dispatch boardDispatch board.

2. Click AdvancedAdvanced to display the Gantt chart at the top of the form and the tabs in the lower pane.

3. Expand each dispatch team list.

4. Select the color-coded graphic that represents a service activity.

5. On the AllAll  tab, TeamTeam tab, UndispatchedUndispatched tab, or RelatedRelated tab, change the selection in the Pr ior ityPr ior ity  field.

6. Click SaveSave.

Dispatch board

View the status of service orders
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View the status of service orders
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More information about service orders

TIPTIP

See also

NOTENOTE

You can use the Dispatch boardDispatch board form to view the status of service activities in service orders.

The form also provides tools to track the flow of service orders and includes additional details to help you

evaluate the urgency of a service order, such the service agreement and service level agreement that it is

associated with.

In order to help you quickly gauge the urgency of a service order, the Gantt chart supports the use of colors.

Colors are used to distinguish the priority of a service call. By default, these colors are red for high priority,

yellow for typical priority, and green for low priority.

You can change the colors on the DispatchingDispatching tab in the Ser vice management parametersSer vice management parameters  form.

Prioritize service orders

Monitor service activities

Dispatch board (form)
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Monitor service activities
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TIPTIP

Example

Open the Dispatch board form

See also

NOTENOTE

The Dispatch boardDispatch board form provides an at-a-glance status update for the various scheduled service activities,

and tools for tracking the general flow of service orders in your company.

To view details about a service activity, select it in the Gantt chart at the top of the Dispatch boardDispatch board form, right-click, and

then click InformationInformation.

By using the tools in this form, you can sort service orders by date, priority, or type of service activity, view the

priority levels that are assigned to service orders, and review which activities are assigned to individual service

orders.

If you must redistribute service activity assignments, you can move the graphical representation of a service

activity to assign it to a different employee or a different date and time.

While monitoring the day's service activity, you notice that John, a service technician, is running behind schedule

on assigned service calls. You also notice that the last call in his list must be completed by the end of the day to

meet service level agreement requirements. By using the drag-and-drop functionality of the Gantt chart, you

can reassign that service call to Meg, who has completed her own service calls ahead of schedule.

Click Ser vice managementSer vice management > PeriodicPeriodic > Dispatch boardDispatch board.

Prioritize service orders

View the status of service orders

Dispatch board (form)
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See also
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This topic describes how to reassign service activities from one worker to another worker. You can reassign

service activities from one worker to another worker even if those workers are assigned to different dispatch

teams.

Use the following steps to reassign an activity to another worker :

1. Click Ser vice managementSer vice management > PeriodicPeriodic > Dispatch boardDispatch board.

2. In the From dateFrom date and To dateTo date fields, enter dates to define the time period to view activities for.

3. Select whether to view closed activities and dispatch information for related teams, and then click OKOK.

4. In the Dispatch boardDispatch board form, click AdvancedAdvanced to display only the Gantt chart at the top of the page. Click

SimpleSimple to display the Gantt chart and the tabs in the form.

5. Expand each dispatch team list.

6. Use either of the following steps to reassign an activity:

Select a color-coded graphic that represents the service activity to reassign. Press the SHIFT key,

and then move the color-coded graphic to the row for another employee.

On the AllAll  tab, TeamTeam tab, UndispatchedUndispatched tab, or RelatedRelated tab, in the WorkerWorker  field, enter the name

of the worker who is replacing the current worker for the activity.

Service activities

Dispatch board
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This topic describes how to reverse unsaved modifications that you make in a dispatch board. For example, you

assign a worker to a service activity, save the information, and then later decide to assign a different worker to

the service activity. You modify the worker in the dispatch board, and then, before saving the change, learn that

the worker just assigned is not available. You can reverse the unsaved modification so that the original worker is

reassigned to the service order.

Use the following steps to reverse unsaved changes in a dispatch board:

1. Click Ser vice managementSer vice management > PeriodicPeriodic > Dispatch boardDispatch board.

2. In the Dispatch boardDispatch board form, enter relevant information in the fields, and then click OKOK.

3. To reverse the most recent change that is not saved, click UndoUndo.

4. To reverse a series of changes that are not saved, continue clicking UndoUndo until each change that you want

to discard is reversed.

Dispatch board

Service activities
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See also
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This topic describes how to view activities in a service order that don’t have a worker assigned to them from a

dispatch team.

NOTENOTE

1. Click Ser vice managementSer vice management > PeriodicPeriodic > Dispatch boardDispatch board.

2. In the Dispatch boardDispatch board window, enter the start date and end date for the period to view dispatch activity

for.

3. Optional: Select whether to include closed activities and related teams in the results.

4. Click OKOK to view the results.

In the Dispatch boardDispatch board form, the AdvancedAdvanced view is automatically displayed. In this view, the Gantt chart at the

top of the page and the tabs at the bottom of the page are displayed. Click SimpleSimple to display only the Gantt

chart.

5. To view a list of service orders that don’t have a dispatch team assigned, click the UndispatchedUndispatched tab.

Dispatch board (form)

Service activities

Dispatch board

Reassign activities
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Update a service BOM element

Delete a service BOM line

See also

NOTENOTE

You can record the history of an element in a service BOM. Every time that you update a BOM line, a history line

is created in the Histor yHistor y  pane. The history line shows the current state of the BOM line.

NOTENOTE

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice agreementsSer vice agreements  > Ser vice agreementsSer vice agreements .

2. Click EditEdit to open the Ser vice agreementsSer vice agreements  details form.

3. On the Action PaneAction Pane, click Ser vice objectsSer vice objects  to open the Ser vice objectsSer vice objects  form.

4. Select the object to update a BOM line for, and then click DesignerDesigner .

5. In the DesignerDesigner  form, select the BOM line to update, and then click Edit BOM lineEdit BOM line.

On the SetupSetup tab, select the Edit when addingEdit when adding check box if you want the Edit BOM lineEdit BOM line form to open when

you drag a line into the service BOM.

6. In the QuantityQuantity  field, enter the quantity.

7. If you want to create a service order line for the replacement item, which can then be invoiced, select the

Create ser vice order lineCreate ser vice order line check box.

8. Click OKOK to close the form.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice agreementsSer vice agreements  > Ser vice agreementsSer vice agreements .

2. Click EditEdit to open the Ser vice agreementsSer vice agreements  details form.

3. On the Action PaneAction Pane, click Ser vice objectsSer vice objects  to open the Ser vice objectsSer vice objects  form.

4. Select the object to delete a service BOM line from, and then click DesignerDesigner .

5. In the DesignerDesigner  form, select the BOM line to delete, and then click Delete BOM lineDelete BOM line.

Template BOMs
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Credit subscription transactions

NOTENOTE

See also
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1. Click Ser vice managementSer vice management > CommonCommon > Ser vice subscr iptionsSer vice subscr iptions  > All ser vice subscr iptionsAll ser vice subscr iptions .

2. Select the subscription attached to the subscription transaction for which you want to create a credit note.

3. Select the AnalyzeAnalyze tab, and then click the Fee transactionsFee transactions  button on the Action Pane.

4. From the Fee transactionsFee transactions  form, select the transaction for which you want to create a credit note.

5. Click FunctionsFunctions  > Select for credit noteSelect for credit note.

6. From the Select for credit noteSelect for credit note form, select the transaction that you want to credit and then click OKOK.

When you create the credit note, make sure that you select Credit notesCredit notes . This is found in the Invoicing methodInvoicing method list in

the Create invoiceCreate invoice dialog box.

If the Reverse accruals on creditingReverse accruals on crediting field in the Ser vice management parametersSer vice management parameters  form is set to ManualManual ,

you have to reverse each accrued revenue transaction individually before you create a credit note proposal for

the transaction.

Invoice subscription transactions
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1. Click Ser vice managementSer vice management > CommonCommon > Ser vice subscr iptionsSer vice subscr iptions  > All ser vice subscr iptionsAll ser vice subscr iptions .

2. On the All ser vice subscr iptionsAll ser vice subscr iptions  list page, select the subscription for which you want to create a

subscription fee transaction.

3. On the Action PaneAction Pane, on the Subscr iptionSubscr iption tab, click Subscr iption feesSubscr iption fees .

4. On the Create subscr iption feeCreate subscr iption fee form, enter the appropriate information in the fields.

5. Click OKOK.
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Reverse accruals of credit amounts

Setup requirements

Account setup

Set up accounts for accrual of subscription revenue

Subscription group setup

Enable revenue accrual on a subscription group

With service subscriptions, you manually accrue revenue in the periods following the date when you invoiced a

fee transaction.

Accrual periods are created for the invoice period that you set up for the subscription fee, and the accrual

periods are based on the period code of the subscription.

You can accrue and reverse accrued revenue.

If you credit invoiced subscription amounts, you can use two methods to reverse the accrual amounts:

You can reverse each accrued revenue transaction individually before you create the credit note proposal

for the transaction. This is the manual method. (manual)

You can have the accrued amounts reversed on the date where the credit note is posted or on the original

posting date of the accrual.

For more information, see Subscription parameters (form).

To accrue revenue, make sure that the following data requirements are met:

The WIP - subscr iptionWIP - subscr iption and the Accrued revenue - subscr iptionAccrued revenue - subscr iption accounts must be set up in the ProjectProject

module.

When you post accrued revenue, the WIP - subscr iptionWIP - subscr iption account is debited with the accrual amount, and the

Accrued revenue - subscr iptionAccrued revenue - subscr iption account is credited with the accrual amount.

1. Click Project management and accountingProject management and accounting > SetupSetup > PostingPosting > Ledger posting setupLedger posting setup.

2. Click the Revenue accountsRevenue accounts  tab, and select WIP - subscr iptionWIP - subscr iption or Accrued revenue - subscr iptionAccrued revenue - subscr iption

to set up the accounts.

To be able to accrue revenue for subscriptions, the Accrue revenueAccrue revenue check box must be selected. This is found

on the Subscr iption groupsSubscr iption groups  form for the group that is attached to the subscription. Click Ser viceSer vice

managementmanagement > SetupSetup > Ser vice subscr iptionsSer vice subscr iptions  > Subscr iption groupsSubscr iption groups .

1. Click Ser vice managementSer vice management > SetupSetup > Ser vice subscr iptionsSer vice subscr iptions  > Subscr iption groupsSubscr iption groups .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/service-management/accruing-subscriptions.md
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Periods
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Transactions

Specify the level of posting details to display for accrued transactions

You must set up an invoicing period code. Unless you want to accrue revenue in the same time intervals as you

use for invoicing, you must also set up an accrual period.

The following table provides an overview of which accrual periods can be set up for each invoicing period:

IN VO IC IN G P ERIO DIN VO IC IN G P ERIO D A C C RUA L  P ERIO DA C C RUA L  P ERIO D

YearsYears YearsYears

Quar terQuar ter

MonthMonth

DayDay

Quar terQuar ter Quar terQuar ter

MonthMonth

DayDay

MonthMonth MonthMonth

DayDay

WeekWeek DayDay

DayDay DayDay

Setting up the invoicing period is a mandatory part of the overall subscription group setup. You can decide

whether to also set up an accrual period for the subscription group. If you set up an accrual period for the

subscription group, this period is suggested in the Period codePeriod code field. This field is found in the AccrueAccrue

subscr iption revenuesubscr iption revenue form, when you accrue subscription revenue. However, the accrual period is optional

information about the subscription group.

Use the following path to open the Accrue subscription revenueAccrue subscription revenue form. Click Ser vice managementSer vice management  > PeriodicPeriodic >

Ser vice subscriptionsSer vice subscriptions > Accrue subscription revenueAccrue subscription revenue.

You can control the number of ledger transactions that are created when you post accrued revenue. On

subscriptions, define if the ledger transactions should be created as a total or per line.

1. Click Project management and accountingProject management and accounting > SetupSetup > Project management and accountingProject management and accounting

parametersparameters .

2. On the FinancialFinancial  tab, in the InvoiceInvoice field, select TotalTotal  or L ineLine.
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Accrue subscription revenue
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1. Click Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders .

2. Double-click the service order that contains the lines that you want to move to another service order.

3. In the Ser vice ordersSer vice orders  form, on the Action Pane, click the Move linesMove lines  button.

4. In the Move ser vice order linesMove ser vice order lines  form, in the Ser vice orderSer vice order  field, select the service order that you

want to move the lines to.

5. Select the Delete empty ser vice orderDelete empty ser vice order  check box to delete the service order that you moved the

service order lines from.

6. Click OKOK.

You can move service order lines only between service orders that are attached to the same service agreement.

Service orders
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Cancel a service order in the Service orders form

Cancel a service order line

TIPTIP

Cancel multiple service orders

NOTENOTE

You can cancel a service order or service order line from the service order itself, or you can cancel multiple

service orders by running a periodic job.

Service orders cannot be canceled if the stage of the service order does not allow cancelation, if the service order has item

requirements, or if the service order has already been posted.

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders . Select the service order,

and on the Action Pane, click Cancel orderCancel order .

1. Click Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders . Double-click the

service order that contains the line you want to cancel.

2. Select the service order line that you want to cancel, and then click Cancel order lineCancel order line to change the

status of the line to CanceledCanceled.

To reverse the cancellation of a service order line and change the status back to CreatedCreated, click Revoke cancelRevoke cancel.

1. Click Ser vice managementSer vice management > PeriodicPeriodic > Ser vice ordersSer vice orders  > Cancel ser vice ordersCancel ser vice orders .

2. Click the SelectSelect button.

3. In the Inquir yInquir y  form, in the Criter iaCriter ia column, select the service orders that you want to cancel.

4. Click OKOK to close the Inquir yInquir y  form.

5. Select the Show InfologShow Infolog check box to generate an Infolog that lists the canceled service orders.

6. Select the Revoke cancelRevoke cancel  check box if you want to reverse the CanceledCanceled status of a service order.

7. Click OKOK.

The selected service orders are either canceled or their progress status of CanceledCanceled has been reversed to InIn

processprocess .

If you select the Revoke cancelRevoke cancel check box, service orders with a progress status of CanceledCanceled are reversed and service

orders with a progress status of In processIn process are not canceled.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/service-management/cancel-service-orders.md


NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Create service orders manually
2/18/2021 • 2 minutes to read • Edit Online

TIPTIP

Create a service order manually from a service agreement

Create a service order manually in the Service orders form

NOTENOTE

Create a service order from a project

NOTENOTE

You can create service orders manually by using a service agreement or by using the Ser vice ordersSer vice orders  form. You

can also create a service order from a project.

You can use automated processes to create service orders.

1. Select Ser vice managementSer vice management > CommonCommon > Ser vice agreementsSer vice agreements  > Ser vice agreementsSer vice agreements .

2. Select a service agreement or create a new service agreement.

3. Select the DeliverDeliver  tab and in the CreateCreate group select Planned ser vice ordersPlanned ser vice orders  to open the CreateCreate

ser vice ordersser vice orders  form.

1. Select Ser vice managementSer vice management > CommonCommon > Ser vice ordersSer vice orders  > Ser vice ordersSer vice orders .

2. Select NewNew  to create a new service order.

3. Create service order lines for the service order.

If the Allow without ser vice agreementAllow without ser vice agreement  check box in the Ser vice management parametersSer vice management parameters  form is selected, you

can post the transactions from the service order lines without attaching the service order to a service agreement. If the

check box is cleared, you must attach the manually created service order to a project before posting the service order

lines.

1. Go to Project management and accountingProject management and accounting > CommonCommon > ProjectsProjects  > All projectsAll projects .

2. In the ProjectsProjects  form, on the Action PaneAction Pane, select the ManageManage tab > select Ser viceSer vice > Ser vice ordersSer vice orders .

3. Follow the previous procedure to create a service order manually in the Ser vice ordersSer vice orders  form. The

Project IDProject ID field displays the project reference.

If the Allow without ser vice agreementAllow without ser vice agreement  check box in the Ser vice management parametersSer vice management parameters  form is selected, you

can post the transactions from the service order lines without attaching the service order to a service agreement. If the

check box is cleared, you must attach the manually created service order to a project before posting the service order

lines.
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Create a service order from the Sales order form
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You can create a service order from the Sales ordersSales orders  form by using the Create a new ser vice order basedCreate a new ser vice order based

on the sales orderon the sales order  wizard.

1. Go to Sales and marketingSales and marketing > CommonCommon > Sales ordersSales orders  > All sales ordersAll sales orders .

2. Open the relevant sales order.

3. On the Sales orderSales order  tab, select Ser vice orderSer vice order  to start the Create a new ser vice order based on theCreate a new ser vice order based on the

sales ordersales order  wizard.

4. Select Next >Next > , and then complete the following steps on the Select agreement for ser vice orderSelect agreement for ser vice order

page:

Use the Ser vice agreementSer vice agreement field to select the service agreement with which the new service

order should be associated.

Optional: Use the Project IDProject ID field to associate this service order with a particular project.

5. Select Next >Next > , and then complete the following steps on the Create ser vice orderCreate ser vice order  page:

Enter a date and time for the service call to begin in the Preferred ser vice timePreferred ser vice time field.

Optional: Modify the text in the Descr iptionDescr iption field. By default, this field contains the description of

the service agreement that you selected on the previous page.

In the ResponsibleResponsible field, select the ID of the employee who is responsible for the agreement, and

if you know what it is, enter the ID of the customer's preferred technician for the service call.

In the Contact IDContact ID field, select the person in the customer's company who should be contacted

regarding this service order.

6. Select Next >Next > , and then select FinishFinish .

Service orders

Create service orders automatically

Create service orders (class form)
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1. Click Ser vice managementSer vice management > PeriodicPeriodic > Ser vice subscr iptionsSer vice subscr iptions  > Accrue subscr iption revenueAccrue subscr iption revenue.

2. In the Period codePeriod code field, select a period code. Revenue is posted for all subscription fee transactions that

have the selected period code.

3. In the Posting datePosting date field, enter a posting date, and then click OKOK.

You cannot post accrued revenue until the fee transactions are invoiced.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/service-management/accrue-subscription-revenue.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Delete service orders
2/18/2021 • 2 minutes to read • Edit Online

NOTENOTE

See also

NOTENOTE

1. Click Ser vice managementSer vice management > PeriodicPeriodic > Ser vice ordersSer vice orders  > Delete ser vice ordersDelete ser vice orders .

2. On the Delete ser vice ordersDelete ser vice orders  form, click SelectSelect to specify the criteria to select the service orders to be

deleted, and then click OKOK.

3. Select the Show InfologShow Infolog check box to generate an Infolog that displays the deleted service orders.

4. Click OKOK.

If you do not specify any criteria to select the service orders, all service orders are deleted. However, when you exit the

Delete ser vice ordersDelete ser vice orders  form, you will have the option to delete all service orders.

Also, you can only delete service orders with a stage that lets you delete them.

Service orders
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1. Click Ser vice managementSer vice management > CommonCommon > Ser vice subscr iptionsSer vice subscr iptions  > All ser vice subscr iptionsAll ser vice subscr iptions .

2. Select a service subscription and then click EditEdit or click Subscr iptionSubscr iption to create a service subscription.

3. Click AnalyzeAnalyze > Fee transactionsFee transactions .

4. Select the fee transaction or fee transactions to invoice, and then click FunctionsFunctions  > Invoice proposalInvoice proposal  to

open the Invoice proposalsInvoice proposals  form.

5. Click Create invoiceCreate invoice and enter the appropriate parameters in the Create invoiceCreate invoice form

6. Click OKOK to create the invoice proposal in the Invoice proposalsInvoice proposals  form.

7. Verify the contents of the invoice, click Post invoicePost invoice to open the Post invoicePost invoice form to post the invoice.

You can also print the invoice from the Post invoicePost invoice form.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/service-management/invoice-subscription-transactions.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Transportation management overview
2/18/2021 • 2 minutes to read • Edit Online

SC EN A RIOSC EN A RIO H O W  T RA N SP O RTAT IO N  M A N A GEM EN T  C A N  H EL PH O W  T RA N SP O RTAT IO N  M A N A GEM EN T  C A N  H EL P

Use external logistics providers for transportation activities. Use Transportation management for inbound and/or
outbound transportation.

The company's own fleet is available for delivery/pickup, and
delivery charges are passed on to customers.

For the outbound processes, you can use Transportation
management to determine the transportation charges and
pass them on to customers. However, the carrier invoice
reconciliation process isn't required.

The company's own fleet is available for delivery/pickup, but
delivery charges aren't passed on to customers, because
product prices include transportation.

A lot of the Transportation management functionality isn't
required. However, you can use Transportation management
to determine the transportation rates and adjust the sales
price accordingly.

Logistics service is provided by another legal entity in the
same company.

Planning transportation in Supply Chain Management

This topic gives an overview of the transportation management functionality in Supply Chain Management.

Transportation management lets you use your company’s transportation, and also lets you identify vendor and

routing solutions for inbound and outbound orders. For example, you can identify the fastest route or the least

expensive rate for a shipment. The following table describes the main scenarios for using Transportation

management.

You can use Transportation management by treating
the other legal entity like any other shipping carrier.
You can't automate the economic transactions
between legal entities. Therefore, you must handle
these transactions manually (for example, by creating
a purchase order).

In the legal entity that provides the logistics services,
Transportation management can be used to
determine transportation rates.

In Transportation management, transportation planning can be based either on orders or on the shipments that

are created based on those orders. The shipments always exist at some point in time but aren't required for

transportation planning. Transfer orders are part of the outbound scenario and can be planned together with

sales orders.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/transportation/transportation-management-overview.md


Inbound transportation

Outbound transportation

When you order items from a vendor, and the items must be delivered to your warehouse, you might want to

arrange the transport of the items yourself. You can use Supply Chain Management to plan the transportation

and receipt of the inbound load. The following illustration shows the business process flow for planning

transportation for an inbound load.

You can plan and process an outbound load to ship specific items from a company’s warehouse to a customer.

You can use Supply Chain Management to plan the transportation and shipping of an outbound load. The

following illustration shows the business process flow for planning and processing outbound loads for shipping.



Load building

NOTENOTE

Supply Chain Management provides a load building strategy that is named the Volume-based load building

strategy. This strategy lets you use the maximum values that are specified for height and weight in the load

template, or you can override the settings by entering new values. To use this strategy, select it in the LoadLoad

building strategybuilding strategy  field on the SetupSetup FastTab on the Load building workbenchLoad building workbench page. In addition, you can

add your own load-building strategies by creating a new class in the Application Object Tree (AOT).
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What engines are available?

T RA N SP O RTAT IO N  M A N A GEM EN T  EN GIN ET RA N SP O RTAT IO N  M A N A GEM EN T  EN GIN E DESC RIP T IO NDESC RIP T IO N

Rate engineRate engine Calculates rates.

Generic engineGeneric engine Simple auxiliary engines that are used by other engines that
do not require data from Supply Chain Management, for
example, an apportionment engine. Apportionment engines
are used to reduce the final costs of transportation to
specific orders and lines, based on dimensions, such as
volume and weight.

Mileage engineMileage engine Calculates the transportation distance.

Transit time engineTransit time engine Calculates the time that is required to travel from the start
to the end destination.

Zone engineZone engine Calculates the zone based on the current address and
calculates the number of zones that must be crossed in
order to travel from address A to address B.

Freight bill typeFreight bill type Standardizes the freight invoice and the freight bill lines and
is used for automatic freight bill matching.

What engines must be configured to rate a shipment?

What’s required to initialize a transportation management engine?

Transportation management engines define the logic that is used to generate and process transportation rates

in Transportation management.

A transportation management engine calculates tasks, such as the carrier ’s transportation rate. The engine

system lets you change calculation strategies at runtime, based on data in Supply Chain Management. A

transportation management engine resembles a plug-in that is related to a particular carrier contract.

The following table shows the transportation management engines that are available.

To rate a shipment using a specific carrier, you must configure multiple transportation management engines.

The Rate engineRate engine is required, but other transportation management engines may be required to support the

Rate engineRate engine. For example, the Rate engineRate engine can be used to retrieve data from the Mileage engineMileage engine to

calculate the rate based on mileage between the source and the destination.

A transportation management engine requires that you set up initialization data in order to function in a specific

way. The setup can include the following types of data:

References to other transportation management engines. For details, see the configuration example in this

section.
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RateBaseAssigner The .NET type that interprets the rate base assignment data
for a particular schema. The syntax of the parameter value
consists of two segments delimited by a vertical bar (

MileageEngineCode Mileage engine code that identifies the mileage engine
record in the database.

ApportionmentEngine Generic engine code that identifies the apportionment
engine in the database.

How is metadata used in transportation management engines?

What can be used as search data in rate calculations?

Do all engine configurations require metadata?

N OT EN OT E

The transportation management engines that are delivered with Supply Chain Management rely on data that is retrieved from
the application. Engines that connect to external systems are not included with Operations. However, the engine-based
extensibility model lets you build extensions using Visual Studio Tools.

How do I configure metadata for a transportation management
engine?

References to .NET types that are used by the transportation management engine.

Simple configuration data.

In most cases, you can click the ParametersParameters  button in the transportation management engine’s setup forms to

configure the initialization data. Example of the configuration of a rate engine that references aExample of the configuration of a rate engine that references a

mileage enginemileage engine The following example shows the setup that is required for a rate engine that is based on the

.NET engine type Microsoft.Dynamics.Ax.Tms.Bll.MileageRateEngine and references a mileage engine.

Transportation management engines that rely on data that is defined in Supply Chain Management can use

different data schemas. The transportation management system enables different transportation management

engines to use the same generic physical database tables. To make sure that run-time interpretation of engine

data is correct, you can define metadata for the database tables. This reduces the cost of building new

transportation management engines because additional table and form structures are not required in

Operations.

The data that you use when you calculate rates is controlled by the metadata configuration. For example, if you

want to search for rates based on postal codes you must set up metadata based on the lookup type of a postal

code.

No, transportation management engines that are used to retrieve the data that is required for rate calculation

from external systems don’t need metadata. The rate data for these engines can be retrieved from external

transportation carrier systems, usually through a web service. For example, can use a mileage engine that

retrieves data directly from Bing maps so that you don’t need a metadata for this engine.

Metadata for transportation management engines is configured differently for the different types of engines.
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Rate engineRate engine Requires a Rate base typeRate base type. The rate base type contains
metadata for the rate base data and the rate base
assignment data. The structure of rate base metadata is
determined by the type of rate engine. The structure of the
rate base assignment metadata is determined by the type of
rate base assigner that is associated with that rate engine.
You set up the rate base type of a rate engine on the RateRate
engineengine page and on the Rate masterRate master  page.

Zone engineZone engine Requires metadata to be set up directly on the zone master.

Transit time engineTransit time engine and Mileage engineMileage engine Retrieves the metadata directly from the mileage engine’s
configuration setup form.

SEQ UEN C ESEQ UEN C E N A M EN A M E F IEL D T Y P EF IEL D T Y P E DATA  T Y P EDATA  T Y P E LO O KUP  T Y P ELO O KUP  T Y P E M A N DATO RYM A N DATO RY

1 Origin postal
code

Assignment String Postal Code Selected

2 Destination state Assignment String State

3 Destination start
postal code

Assignment String Postal Code Selected

4 Destination end
postal code

Assignment String Postal Code Selected

5 Destination
country

Assignment String Country/region

NOTENOTE

  Example of metadata for a rate engineExample of metadata for a rate engine The transportation management engine requires identification of

the origin address, the destination state and country/region, and the start and end point of the shipment. By

using these requirements, the metadata would look like the data in the following table. The table also includes

information about what type of input data is required.

Define this information in Transpor tation managementTranspor tation management > SetupSetup on the Rate base typeRate base type page.
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Create a new TMS engine

This topic describes how to create a new transportation management engine in Dynamics 365 Supply Chain

Management.

Transportation management (TMS) engines define the logic that is used to generate and process transportation

rates in Transportation management. Supply Chain Management provides several different engine types that

calculate different parameters, such as rates, transit times, and the number of zones that will be crossed during

transit. This article explains how to use the Microsoft Visual Studio development environment together with

Supply Chain Management development tools to create and deploy a new TMS engine, and then how to set up

the engine in Operations. For more information about the engines, see Transportation management engines.

This section explains how to create a class library that has a TMS engine implementation, and how to reference

it from a Supply Chain Management model.

1. To deploy your new engines, you must have a model that will contain the engines. On the DynamicsDynamics

365365  > Model ManagementModel Management menu, click Create modelCreate model  to create a new model. On the first page of the

Create modelCreate model  wizard, name the model TMSEnginesTMSEngines .

2. On the next page, select Create new packageCreate new package.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/transportation/create-new-transportation-management-engine.md
file:///T:/eiye/ac1a/dynamics365/supply-chain/transportation/media/012.png


3. On the next page, select the ApplicationSuiteApplicationSuite model to reference. (The ApplicationPlatformApplicationPlatform model is

preselected.)

4. On the next page, click FinishFinish to confirm the creation of a new model.
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5. In a new solution, create a new Supply Chain Management project, and name it TMSThirdPar tyTMSThirdPar ty . In the

project properties, set the project's model to TMSEnginesTMSEngines .

6. Add a new C# class library to your solution, and name it ThirdPar tyTMSEnginesThirdPar tyTMSEngines .

7. In the ThirdPartyTMSEngines project, add references to Supply Chain Management–specific assemblies:

[Packages root]\ApplicationPlatform\bin\Dynamics.AX.ApplicationPlatform.dll
[Packages root]\ApplicationFoundation\bin\Dynamics.AX.ApplicationFoundation.dll
[Packages root]\ApplicationSuite\bin\Dynamics.AX.ApplicationSuite.dll

Microsoft.Dynamics.ApplicationPlatform.Environment.dll
Microsoft.Dynamics.AX.Data.Core.dll
Microsoft.Dynamics.AX.Framework.Linq.Data.AdoNet.dll
Microsoft.Dynamics.AX.Framework.Linq.Data.dll
Microsoft.Dynamics.AX.Framework.Linq.Data.Interface.dll
Microsoft.Dynamics.AX.Framework.Linq.Data.Msil.dll
Microsoft.Dynamics.AX.Server.Core.dll
Microsoft.Dynamics.AX.Xpp.AxShared.dll
Microsoft.Dynamics.AX.Xpp.Support.dll

[Packages root]\ApplicationSuite\bin\Microsoft.Dynamics.AX.Tms.dll
[Packages root]\ApplicationSuite\bin\Microsoft.Dynamics.AX.Tms.Base.dll

Application assemblies that enable X++ types to be referenced. These assemblies can be found in

the following locations. [Packages root] is the path of the location where all the deployed

assemblies are placed, such as C:\Packages.

Framework assemblies that enable access to data, LINQ, and auxiliary functions. All these

assembles can be found in [Packages root]\bin.

The core TMS assembly (which contains engines) and the TMS base assembly (which contains

helpers, constants, data transfer class definitions, and so on). These assemblies can be found in the

following locations.

8. Rename the C# class that is automatically generated in the ThirdPartyTMSEngines project to
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namespace ThirdPartyTMSEngines
{
    using Dynamics.AX.Application;
    using Microsoft.Dynamics.Ax.Tms.Base.Data;
    using Microsoft.Dynamics.Ax.Tms.Base.Utility;
    using Microsoft.Dynamics.Ax.Tms.Bll;
    using System.Xml.Linq;
    public class SampleRatingEngine : BaseRateEngine
    {
        public override RatingDto rate(TmsTransactionFacade transactionFacade, XElement shipment, 
TMSRateMasterCode rateMasterCode)
        {
           XElement re = shipment.RetrieveOrCreateRatingEntity(this.RatingDto);
           re.AddRate(TmsRateType.Rate, 100);
           return this.RatingDto;
        }
    }
}

SampleRatingEngineSampleRatingEngine.

9. Implement the engine. Because we are creating a rate engine in this example, we inherit from the base

class for rate engines. The base class implements most of the rate engine interface

(TMSFwkIRateEngineTMSFwkIRateEngine). We just have to implement the rate method. To keep this example simple, we

will make this method register a hard-coded rate of 100. You can create engines that implement any of

the engine interfaces, such as TMSFwkIAccessorialEngineTMSFwkIAccessorialEngine. All the engine interfaces are defined in X++.

10. Build the solution.

11. Add a new reference to the TMSThirdParty project. The reference should point to the

ThirdPartyTMSEngines project. When you've finished, your solution should look like this.

12. Build the solution. Verify that the new library appears in the ReferencesReferences  node in Application Explorer.
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Deploy the TMS engine as a package

Set up the TMS engine in Supply Chain Management

One way to deploy third-party TMS engines is through a deployment package. This approach is recommended

in a production environment. In a development environment, you can manually copy the assemblies, as

described in the next section, "Set up a TMS engine in Supply Chain Management." To deploy the engine as a

package, follow these steps.

1. On the Dynamics 365Dynamics 365  > DeployDeploy  menu, click Create Deployment PackageCreate Deployment Package.

2. In the Create Deployment PackageCreate Deployment Package dialog box, select the TMSEngines model, and enter the path where

you want to store your package files.

3. You can now deploy the package to the target environment. For a tutorial, see Install a deployable

package.

This section explains how to set up Supply Chain Management to use a TMS engine, and shows how the new

engine that we have created is used in rate shopping. The example in this section uses the USMF demo data

company.

1. Create a new engine as described in the "Create a new TMS engine" section.

2. Build your solution.

3. Copy the resulting assembly into the binary location of the Supply Chain Management server,
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Tips and tricks

[AOSWebRoot]bin. Note:Note: This step is relevant only in a development environment. In a production

environment, you should deploy through a deployment package. For instructions, see the previous

section, "Deploy the TMS engine as a package."

4. In Supply Chain Management, on the Rate enginesRate engines  page, create a new rating engine. The engine should

point to the engine assembly that is produced by building the engine class library and the engine class

that you implemented.

5. Create a shipping carrier that uses the Sample rate engine. Because our engine doesn't use any data, you

don’t have to assign a rate master.

6. On the Rate route workbenchRate route workbench page, click Rate shopRate shop. You should see a rate of 100.00 from

SampleCarrier, as shown in the following screen shot. In this example, we are rate shopping for a route

from warehouse 24 to customer US-004. However, but because the rate is hard-coded, you will always

see a rate of 100.00.

If you’re using development tools for Supply Chain Management, it's useful to add a new project to your

solution. If you set this project as your startup project and start a debugging session, you can debug both

file:///T:/eiye/ac1a/dynamics365/supply-chain/transportation/media/081.png
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NOTENOTE

X++ and C# code in the same debugging session.

Every time that you change and recompile your ThirdPartyTMSEngines project, you must manually copy the

resulting assembly to the binary location or deploy through a deployment package. Otherwise, you might

run by using a stale assembly.

After you execute TMS-specific operations inSupply Chain Management, the Internet Information Services

(IIS) worker process might lock the ThirdPartyTMSEngines assembly so that the assembly can’t be updated.

In this case, restart the w3svc process.
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Associate a fuel index with a carrier as an
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Create an accessorial master

Create a carrier accessorial charge

Create an accessorial assignment

This guide shows how to create an accessorial assignment, carrier accessorial charge, accessorial master for fuel

surcharge, and associate a carrier fuel index with a carrier. You need to have set up a carrier fuel index before

you run this guide. You can use the "Set up a carrier fuel index" guide to do this. These setup tasks are typically

done by a Logistics manager. The demo data used to create this procedure is USMF.

1. Go to Transportation management > Setup > Rating > Accessorial masters.

2. Click New.

3. In the Accessorial master field, type a value.

4. In the Name field, type a value.

5. Click Save.

1. Go to Transportation management > Setup > Rating > Carrier accessorial charges.

2. Click New.

3. In the Carrier accessorial ID field, type a value.

4. In the Shipping carrier field, click the drop-down button to open the lookup.

5. In the list, find and select the desired record.

6. In the list, click the link in the selected row.

7. In the Carrier service field, click the drop-down button to open the lookup.

8. In the list, click the link in the selected row.

9. In the Accessorial master field, click the drop-down button to open the lookup.

10. In the list, find and select the desired record.

11. Click Save.

In this example, choose Truck Carrier.

In this example, choose the newly created Accessorial master.

1. Click Accessorial assignments.

2. Click New.

3. In the Name field, type a value.

4. Toggle the expansion of the Criteria section.

5. In the ZIP/postal code from field, type a value.

6. In the ZIP/postal code to field, type a value.

7. Toggle the expansion of the Calculation section.

In the criteria, you can choose to always apply the fuel surcharge or for this example choose that it

only applies within a certain region.

In the calculation section you can specify how to calculate the fuel surcharge. This calculation depends
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Update the carrier rating profile

NOTENOTE

8. In the Accessorial fee type field, select 'Fuel surcharge'.

9. In the Accessorial unit field, select 'Mileage'.

10. In the Region field, click the drop-down button to open the lookup.

11. In the list, click the link in the selected row.

12. Click Save.

on the Accessorial unit that you chose as the base for your calculation.

1. Go to Transportation management > Setup > Carriers > Shipping carriers.

2. In the list, find and select the desired record.

3. Toggle the expansion of the Rating profiles section.

4. Click Edit.

5. In the Carrier fuel index field, click the drop-down button to open the lookup.

6. In the list, click the link in the selected row.

7. Click Save.
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Turn on the USMCA feature

Document content

Print a USMCA certification of origin document

This feature lets you print the certification of origin documents required by the United States-Mexico-Canada

Agreement (USMCA).

The USMCA certification of origin document contains the minimum data elements required for declaration.

Some data elements can be pre-filled before printing while others must be filled in manually after printing. To

obtain preferential tariff treatment, the document must be completed and in the possession of the importer at

the time the declaration is made. The document may be completed by the importer, exporter, or producer.

You can print the document for a single shipment from the All shipmentsAll shipments  list page or from the ShipmentShipment

detailsdetails  page.

The document is only accessible when the country on the primary address for the legal entity is the United

States.

Depending on the document print selection, the document can be pre-filled with data from your system. It is

possible to change or add data to the printed document by exporting the printed document to an editable

format, such as Microsoft Word. After export, you can apply any required changes before a declaration is made.

Before you can use the USMCA feature, it must be turned on in your system. Admins can use the feature

management settings to check the status of the feature and turn it on. In the Feature managementFeature management workspace,

the feature is listed in the following way:

Module:Module: Transportation management

Feature name:Feature name: USMCA certification of origin document

The USMCA certification of origin document contains the following data elements:

Address elements

Role of the certifying party

Single shipment

Invoices

Blanket period

Item details

Certifier signature

Number of pages

For more information about each of these elements and how their values are found, see the remaining sections

in this topic.

To print a USMCA certification of origin document for a shipment, do the following:

1. Do one of the following:
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Certifying partyCertifying party

C ERT IF Y IN G PA RT YC ERT IF Y IN G PA RT Y DESC RIP T IO NDESC RIP T IO N

[Blank] Adds the following details to the document:

Exporter Adds the following details to the document:

2. On the Action Pane, open the ShipmentsShipments  tab and, from the Pr intPr int group, select USMCA cer tificate ofUSMCA cer tificate of

or iginorigin .

3. The Cer tificate or or iginCer tificate or or igin dialog box opens. Make the settings described in the following subsections and

then select OKOK to generate the document.

4. A preview of the document opens. Use the commands provided on the Action Pane to print or export the

document as needed.

Go to Transpor tation management> Shipments > All shipmentsTranspor tation management> Shipments > All shipments  and select the shipment you

want to print the document for.

Open the Shipment detailsShipment details  page for the shipment you want to print the document for (there are

several ways to get here, including from the All shipmentsAll shipments  page).

Use the Cer tifying par tyCer tifying par ty  drop-down list to identify the type of party that is printing the document. Specify

whether the certifying party is the Exporter, Exporter and Producer, Producer, or Importer; or leave it blank if the

certifying party is none of these. The option you select determines what is printed in the address sections of the

document.

The Cer tifying par tyCer tifying par ty  that you choose will be included in the printed document.

The document can be printed for both inbound and outbound shipments. Select Importer as Cer tifying par tyCer tifying par ty

for inbound shipments only.

The following table describes the types of information that are included in the document based on the

Cer tifying par tyCer tifying par ty  that you choose.

Cer tifier detailsCer tifier details : Uses the address details for the
shipping warehouse, if available; otherwise it uses the
shipping site address, if available; otherwise it uses
the address of the legal entity (company) selected in
Supply Chain Management.

Expor ter detailsExpor ter details : Blank

Producer detailsProducer details : Blank

Impor ter detailsImpor ter details : Blank

Cer tifier detailsCer tifier details : Uses the address details for the
shipping warehouse, if available; otherwise it uses the
shipping site address, if available; otherwise it uses
the address of the legal entity (company) selected in
Supply Chain Management.

Expor ter detailsExpor ter details : Uses the address details for the
legal entity.

Producer detailsProducer details : Blank

Impor ter detailsImpor ter details : Uses the invoice account for the
related sales order.



Exporter and Producer Adds the following details to the document:

Importer Adds the following details to the document:

Producer Adds the following details to the document:

C ERT IF Y IN G PA RT YC ERT IF Y IN G PA RT Y DESC RIP T IO NDESC RIP T IO N

Has various producersHas various producers

Blanket periodBlanket period

Is single shipmentIs single shipment

Cer tifier detailsCer tifier details : Uses the address details for the
shipping warehouse, if available; otherwise it uses the
shipping site address, if available; otherwise it uses
the address of the legal entity (company) selected in
Supply Chain Management.

Expor ter detailsExpor ter details : Uses the address details for the
legal entity.

Producer detailsProducer details : Uses the address details for the
legal entity.

Impor ter detailsImpor ter details : Uses the invoice account for the
related sales order.

Cer tifier detailsCer tifier details : Uses the address details for the
shipping warehouse, if available; otherwise it uses the
shipping site address, if available; otherwise it uses
the address of the legal entity (company) selected in
Supply Chain Management.

Expor ter detailsExpor ter details : Blank

Producer detailsProducer details : Blank

Impor ter detailsImpor ter details : Uses the address details for the
legal entity.

Cer tifier detailsCer tifier details : Uses the address details for the
shipping warehouse, if available; otherwise it uses the
shipping site address, if available; otherwise it uses
the address of the legal entity selected in Supply
Chain Management.

Expor ter detailsExpor ter details : Blank

Producer detailsProducer details : Uses the address details for the
legal entity.

Impor ter detailsImpor ter details : Blank

The Cer tifying par tyCer tifying par ty  drop-down list controls the text to be used for the producer details in the document.

Choose one of the following:

Various producers - Prints the text "Various" in the producer details.

Available upon request - Prints the text "Available upon request by the importing authorities" in the producer

details.

When the Cer tifying par tyCer tifying par ty  is set to Exporter and Producer or Producer, then the Has var ious producersHas var ious producers

setting is overruled, and the producer address details will be the same as the certifier.

Use the Blanket per iod fromBlanket per iod from and Blanket per iod toBlanket per iod to settings to establish a blanket period, during which the

document will cover multiple shipments of identical goods, even though the document is printed for only one

shipment. You can set the blanket period dates without any constraints, and it will be added to the document.

You can also leave these settings blank or set them in the past.



Other information included in the document

Invoice numberInvoice number

Item detailsItem details

Certifier signature and dateCertifier signature and date

Consists of number of pagesConsists of number of pages

Page numbersPage numbers

NOTENOTE

In the Cer tificate of or iginCer tificate of or igin dialog box, set Is single shipmentIs single shipment to one of the following:

Yes - Adds "Single Shipment: Yes" next to the invoice number.

No - Adds nothing.

In addition to the optional elements that you select using the Cer tificate or or iginCer tificate or or igin dialog box, the USMCA

certification of origin document will include the information and custom fields summarized in the following

subsections. Some of this information must be entered manually after you generate the document.

The IDs of sales invoices related to shipments are printed on the document irrespective of the blanket period.

Invoice numbers are printed irrespective of the Is single shipmentIs single shipment selection.

The document provides several sections that list specific item details, which are:

SKU numberSKU number : Prints the item number of the released product.

Descr iptionDescr iption: Prints either the description or name for the released product. If a description in the user's

language exists, then this is printed. If no such description exists, then the name in the user's language is

printed. If that name doesn't exist, then the item name is printed.

Harmonized System (HS) Tar iff ClassificationHarmonized System (HS) Tar iff Classification: Prints the Harmonized Tariff Schedule associated to

the product. You can set up these schedules by going to Transpor tation Management > Setup >Transpor tation Management > Setup >

Transpor tation standard > Harmonized Tar iff SchedulesTranspor tation standard > Harmonized Tar iff Schedules .

Origin cr iter ion:Origin cr iter ion: You must manually enter data in this section the first time you release the document.

Countr y of or igin:Countr y of or igin: Prints the country of origin, which you apply by going to Product informationProduct information

management > Setup > Product compliance > Countr y of or iginmanagement > Setup > Product compliance > Countr y of or igin (see also Country of origin).

The ISO code for the country of origin is printed based on the country/region of destination in the

shipment delivery address and the item. If no country of origin data has been set up, then this value

reverts back to the setting found at Released product > Foreign trade > OriginReleased product > Foreign trade > Origin . If still no country of

origin data is found, then you must manually enter the country of origin after generating the document.

You must enter this manually after generating the document.

The user signing the certification must manually enter the number of pages (for verification) after generating

the document.

Current page and number of pages printed at the bottom of the document.
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Master bill of lading

NOTENOTE

This topic describes how to create a bill of lading when using warehouse management processes.

A bill of lading is a legal document between the company that ships the items and the carrier. The document

accompanies the shipped items, and it serves as a receipt of shipment when the items are delivered at the

destination. If you're using warehouse management, there are two ways to generate a bill of lading:

Create the report manually, using the Bill of ladingBill of lading page.

Generate the report from the Load planning workbenchLoad planning workbench.

If you generate the bill of lading from the Load planning workbenchLoad planning workbench, the load status must be Shipped.Shipped. If

there's more than one shipment in the load, a bill of lading is created for each shipment. After a bill of lading has

been created you can make changes to it on the Bill of ladingBill of lading page.

If there's more than one shipment in the load, you can generate a master bill of lading. This has the same layout

and information as a bill of lading, but contains the summarized content for all the shipments. If the Create aCreate a

master bill of lading when there's more than one shipment on a loadmaster bill of lading when there's more than one shipment on a load option is set to YesYes  on the

Transpor tation management parametersTranspor tation management parameters  page, a master bill of lading is automatically generated if you

create a bill of lading from the Load planning workbenchLoad planning workbench, and there's more than one shipment. You can also

get a list of the bills of lading by clicking Related informationRelated information > Bill of ladingBill of lading. If you're creating bills of lading

manually, you can create a master bill of lading on the Bill of ladingBill of lading page.
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Route plans

Route guides

Scheduled routes

Load building workbench

This article describes the various elements that you use to plan transportation routes in Dynamics 365 Supply

Chain Management.

You can use route plans and route guides for complex transportation routes that have multiple stops. If the same

route will be used on a regular basis, you can set up a scheduled route.

A route plan contains route segments that provide information about the stops that are visited on the route and

the carriers that are used for each segment. You must define the stops on the route as hubs. A hub can be a

vendor, a warehouse, a customer, or even just a reloading place where you change carrier. For each segment, you

can define “spot rates” for various charges. Here are some examples:

Charges for travelling to the given segments

Charges for a picking up the goods

Charges for dropping off the goods

Each route plan must be associated with a route guide.

A route guide defines the criteria for matching a load to a specific route plan. For example, you can specify an

origin hub and a destination hub, limits for the container volume or weight, and a shipping carrier, service, or

group. Route guides are available on the Rate route workbenchRate route workbench page, where loads can be matched to routes

either manually or automatically. If the route guide is for a scheduled route, it's also available on the LoadLoad

building workbenchbuilding workbench page.

A scheduled route is a predefined route plan that has a schedule for the shipping dates. Scheduled routes and

non-scheduled routes differ in the way that loads are assigned to them. If you assign a non-scheduled route by

using the Rate route workbench, only the load and the route guide are validated. If you assign a scheduled route,

the dates and addresses from the orders and the hubs, and the date on the route plan, are also considered. You

don't have to use the Rate route workbench page to manually assign loads to a scheduled route. Instead, you

can use the Load building workbench to suggest that loads be built based on the customer addresses and

delivery dates from sales orders for a given scheduled route. For scheduled routes, the route plan will have fixed

origin and destination hubs. Typically, the shipping carrier and service will be the same for all segments, but they

can differ. The destination hubs are created by using the postal codes of the customers that are visited on the

route. Several route schedules can be defined for one route plan. The route plan must be associated with a route

guide. However, for scheduled routes, the plan can be associated with only one route guide. The route schedule

is used only to create the actual routes on the Route scheduleRoute schedule page. You can use the default load template

when you propose loads on the Load building workbench.
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The Load building workbench uses the customer addresses and delivery dates from sales orders, and the

scheduled routes that are available, to propose a load. By default, the values from the route are entered on the

workbench. However, you can select a "from" date that is earlier than the "from" date on the route. When a load

is proposed, the delivery address and delivery date of all open sales orders are checked. If the postal code of the

delivery address matches the postal code of a hub in the route plan, and if the delivery date is within the range

that is selected in the criteria, the sales order is proposed for the load. The capacity of the load template is also

considered. Only one load is proposed at a time. If you have a sales order that isn't included, you might have to

use a different load template (for example, a load template for a bigger truck or container) or plan an extra

delivery.
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Building loads

NOTENOTE

This article describes the feature for consolidating shipments in a hub when you deliver goods from different

warehouses to the same customer, or when you receive goods from multiple vendors in the same warehouse.

It can be useful to consolidate shipments in a hub when you deliver goods from different warehouses to the

same customer, or when goods are delivered from multiple vendors to the same warehouse.

Before you can use hub consolidation, you must enable the In transit planningIn transit planning option on the Transpor tationTranspor tation

management parametersmanagement parameters  page. You must also create the hubs where consolidation will occur. The following

diagram shows an example of hub consolidation. In this case, sales orders from different warehouses are going

to the same customer. The basic loads are created based on sales orders in the usual way, by using the LoadLoad

planning workbenchplanning workbench page. To consolidate the two loads in a hub before they are delivered to the customer, on

the Load planning workbenchLoad planning workbench page, in the Transpor tationTranspor tation field, select Hub consolidationHub consolidation. When you

select the correct hub for each load, the loads will have the hub as the “drop off” destination. You will also have

two “transportation request lines” in the Supply and DemandSupply and Demand section on the Load planning workbenchLoad planning workbench

page. You can then add these two lines to a new load. This new load will have both sales order lines, and will also

have the hub as the “pick up” address and customer A as the “drop off” destination. The three loads are then

ready to be rated and routed like any other load. You can select whatever shipping carrier the system suggests

for each load. 

You can also use the same method to consolidate loads for multiple transfer orders. In this case, customer A in

the preceding diagram is a warehouse. Alternatively, you can consolidate loads for multiple purchase orders,

where the loads are delivered from different vendors to the same warehouse. You can have more than one

consolidation hub, and can consolidate in multiple hubs for more loads that come from different warehouses.

After you build your basic loads and use the hub consolidation option, you build the new loads by using the

consolidated transportation request lines. You then rate and route your loads.
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Create a sales order

Create a new load

Rate and route the load

This topic shows how to use the load planning workbench to create a load for a sales order. As a prerequisite

we'll create the sales order first. This procedure is part of the daily work for the transportation coordinator. The

demo data company used to create this procedure is USMF.

1. Go to the Navigation pane > Modules > Accounts receivable > Orders > All sales ordersNavigation pane > Modules > Accounts receivable > Orders > All sales orders .

2. Select NewNew .

3. In the Customer accountCustomer account field, select the drop-down button to open the lookup.

4. Select account US-004US-004 .

5. Select OKOK.

6. In the Item numberItem number  field, select the drop-down button to open the lookup.

7. Select item A0001A0001 . A0001A0001  is enabled for transportation management.

8. In the S iteSite field, select the drop-down button to open the lookup, then select an item.

9. In the QuantityQuantity  field, enter a number.

10. In the WarehouseWarehouse field, type '24' for this example. This warehouse is enabled for transportation

management and advanced warehouse management.

11. Select SaveSave.

12. Close the page.

1. Go to the Navigation pane > Modules > Transpor tation management > Planning > LoadNavigation pane > Modules > Transpor tation management > Planning > Load

planning workbenchplanning workbench.

2. Select the Sales linesSales lines  tab. Now you'll build the load for the sales order that you just created. Loads can be

built based on supply and demand from purchase orders, transfer orders, and sales orders.

3. On the Action Pane, select Supply and demandSupply and demand.

4. Select To new loadTo new load.

5. In the Load template IDLoad template ID field, select the drop-down button to open the lookup. The Load template defines

maximum measurements for weight and volume of the entire load. For example, the load template might

represent the size of a container or truck. Select an item.

6. Select OKOK.

1. Select Rating and routingRating and routing.

2. Select Rate route workbenchRate route workbench.

3. Select Rate shopRate shop.

4. In the list, find and select the desired record.

5. Select AssignAssign.

6. Close the page.
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Where it applies

How it is set up
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The functionality for including the container weight and volume on a load gives a clear representation of the

total weight and volume of containers and items that are going on a load.

A load contains a single shipment or multiple shipments, and these shipments contain distinct items that belong

to a single sales order or multiple sales orders. The items are stored inside a container, and containers are

loaded on a load. Items that are outside a container can also be part of a load. Based on these conditions, the

system calculates values for the weight and volume on the load by considering the weight and volume of both

containers and items.

If the calculated values aren’t precise, you can adjust them by entering the actual values for the weight and

volume on the load. The values for the weight and volume are used in transportation management processes.

For example, the values are used in the rate route workbench, where they help define the rate and route for

loads, and they are also used for transportation tenders and driver check-in.

The functionality for including the container weight and volume on a load applies in transportation

management processes, such as the rate route workbench, transportation tenders, and driver check-in.

The number of containers that should be considered for a load is calculated based on the weight and volume of

the container, and on the percentage of the container is used.

To set the weight and volume for a container, click Warehouse managementWarehouse management > SetupSetup > ContainersContainers  >

Container typesContainer types .

To set the container utilization percentage, click Warehouse managementWarehouse management > SetupSetup > ContainersContainers  >

Container groupsContainer groups , and then enter a value in the Container utilization percentageContainer utilization percentage field.
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Select a load to reconcile

Create a carrier invoice

Reconcile the invoice

Submit the invoice for approval

]

This procedure shows how to reconcile freight manually. This is typically done by a transportation coordinator.

You can use this procedure in the USMF demo data company.

1. Go to Transportation management > Planning > Load planning workbench.

2. Clear the Hide shipped and received check box.

3. In the list, select the load that has load ID 00006.

If you reconcile freight manually and don't receive carrier invoices automatically, you can create an invoice

based on the freight bill.

1. Click Related information.

2. Click Freight bill details.

3. Click Generate freight bill invoice.

4. In the Invoice field, type a value.

5. Click OK.

When you reconcile a carrier invoice and a freight bill, this is done line by line.

1. Click Match freight bills and invoices.

2. Expand the Invoice details section.

3. Expand the Unmatched freight bill details section.

4. In the list, mark the selected row.

5. Click Match.

6. Expand the Matched freight bill details section.

1. Click Submit for approval.

2. Close the page.

3. Clear the Hide approved check box.

4. Click Vendor invoice journals.

5. Click to follow the link in the Reference journal number field.

6. Click Lines.
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The freight reconciliation process

Manual reconciliation

This topic describes the freight reconciliation process.

Freight reconciliation can be done manually, or it can be set up to occur automatically. To use automatic freight

reconciliation, you must set up an audit master where you can define criteria that determine which freight bills

are matched automatically.

Freight rates are calculated by the rate engine that is associated with the relevant shipping carrier. When a load

is confirmed, a freight bill is generated, and the freight rates are transferred to it. The freight rates are

apportioned as miscellaneous charges to the relevant source document (purchase order, sales order, and/or

transfer order), depending on the setup that is used for the regular billing process. The freight reconciliation

process (which is also known as the matching process) can start as soon as the freight invoice arrives from the

shipping carrier. The invoice can be received electronically or on paper. If the invoice is received on paper, you

can generate an electronic invoice by using the freight bill as a template.

If you're reconciling freight manually, you must match each invoice line with the freight bill line or lines for the

load that is being invoiced. You do this matching on the Freight bill and invoice matchingFreight bill and invoice matching page. If the

amount on the invoice line doesn’t match the freight bill amount, you must select a reconciliation reason for the

difference. If there are multiple reasons for reconciliation, you can split the unmatched amount across them. The

reconciliation reason determines how the difference amounts are posted in the general ledger. When the

reconciliation of the whole invoice amount is accounted for, it's submitted for approval, and then the journal is

posted. The following illustration shows how to generate a freight invoice and do freight reconciliation.
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Automatic reconciliation

Match freight bills with freight invoices using automatic or manual
reconciliation

Auto matchingAuto matching

Manual matchingManual matching

To use automatic reconciliation, you must specify the schedule for reconciliation, and the invoices and shipping

carriers to use. The matching of the invoice lines and freight bills is done according to the setup of the audit

master and freight bill type. After you run the automatic reconciliation, you must handle any invoices that the

system can't match. You must then process these invoices manually before you can post all the invoices for

payment.

Matching is the process of finding the freight bills that correspond to each freight invoice. This can be done by

matching the invoice lines one-by-one (manual matching), or by matching all available invoices at once (auto

matching).

When matching multiple freight invoices to the same freight bill, the process for auto matching works as

follows:

1. All freight invoices not matched are sorted by amount, with largest amount first.

2. The freight invoices are matched one-by-one, until the freight bill has no positive amount remaining.

3. Depending on the setup of the audit master and the remaining amount on the freight invoices, the remaining

amount is set.

All freight bills with positive amounts will be available for matching. Similar to auto matching, the user will only

be able to match freight invoices with negative amounts to freight bills not fully matched.
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ExampleExample

Automatic matching resultAutomatic matching result

Manual matching resultManual matching result

M a n u a l  m a t c h i n g  c a se  1M a n u a l  m a t c h i n g  c a se  1

M a n u a l  m a t c h i n g  c a se  2M a n u a l  m a t c h i n g  c a se  2

NOTENOTE

Suppose that you have a freight bill (FB) for an amount of 1500 and you have created three freight invoices for

the freight bill with one invoice line for each invoice with following settings:

Original freight bill (FB): Amount 1500

Invoice 1 (Inv1): Amount 1000

Invoice 2 (Inv2): Amount 600

Invoice 3 (Inv3): Amount -100

Auto matching will execute in following order :

1. Sort all freight invoices descending by amount: Inv1 -> Inv2 -> Inv3.

2. Match Inv1 with FB. Inv1 has 1000 matched and FB has 500 amount remaining, so the status is set to

Partially matched.

3. Match Inv2 with FB. Inv2 has 500 matched and FB has 0 remaining, so the status is set to Fully matched.

4. Because FB is now fully matched, Inv3 won't be processed.

For manual matching, the results vary depending on the order of the matching, as illustrated in the following

example cases.

One way to do manual matching for this example is to proceed as follows:

1. Match FB with Inv1. FB has 500 amount remaining, so the status set to Partially matched.

2. Match Inv2 with FB. Inv2 has 500 matched and FB has 0 remaining, so the status is set to Fully matched.

3. When manually matching Inv3, you won't find any unmatched freight bills.

This case is essentially the same as auto matching

Another way to do manual matching for this example is to proceed as follows:

1. Match Inv3 with FB. Now FB has amount remaining 1600, which is the same as subtracting negative 100 on

top of 1500. Both FB and Inv3 have a matched quantity of -100.

2. Match Inv1 and Inv 2 with FB one after another. FB is fully matched.

As this example shows, matching freight invoices with negative amounts should only be done manually. This will

ensure that it is always possible to match the freight invoices with negative amounts to a freight bill not fully

matched because that enables you to control the matching sequence.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Register driver check-in and check-out for an
appointment
2/18/2021 • 2 minutes to read • Edit Online

Select an appointment

Register driver check-in

Register driver check-out

NOTENOTE

This procedure shows how to register a driver check-in and a driver check-out. This is typically done by a

transportation coordinator. You can use this procedure in the USMF demo data company. Before you start, there

must be an appointment set up for a load. To create an appointment, you can run the "Set up an appointment for

a load" procedure as a prerequisite.

1. Go to Transportation management > Planning > Dock appointment scheduling > Driver check-in and check-

out.

2. Select an appointment.

1. Click Driver check-in.

2. In the Trailer number field, type a value.

3. In the Driver name field, type a value.

4. In the Driver license field, type a value.

5. Click OK.

1. Click Driver check-out.

2. Click OK.
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NOTENOTE

Transportation management lets you set up discounts to be applied on top of the transportation price calculated

by the rating engine. You can specify each discount either as a percentage of charges or as a fixed amount.

To set up discounts for transportation management, go to Transpor tation management > Setup > RatingTranspor tation management > Setup > Rating

> Discounts> Discounts .

You can choose whether to pass the discount on to your customer (by setting the discount type to customer) or

to retain it in the company (by setting the discount type to shipper). This lets you define a setup in which you

earn a margin on the calculated freight charges.

You can set up multiple qualifiers for each discount, such as carrier, carrier service, delivery terms, customer,

destination, and more.
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NOTENOTE

As with all miscellaneous charges, transportation-generated charges must be associated with a charge code.

Otherwise, they won't be added back to the order as a miscellaneous charge. The Charges codeCharges code determines

how the charge is accounted for in relation to the order and order line where it is added.

Go to Transpor tation management > Setup > Rating > Miscellaneous chargesTranspor tation management > Setup > Rating > Miscellaneous charges  to define the qualifying

criteria that determine when a specific Charges codeCharges code is applied to a charge.

You should have at least one setup for each relevant Charges moduleCharges module setting (Customer and Vendor) where

the Miscellaneous charge typeMiscellaneous charge type is set to None. If this is missing, the miscellaneous charge will not be added to

the order.
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Create a mode

Create a transportation method

NOTENOTE

The transportation management mode represents the type of transport that the carrier uses for freight

deliveries, such as less than load (LTL), truckload (TL), or parcel. The transportation method represents the form

of transport that the carrier uses for freight deliveries, such as air, ground, ocean, or rail.

Modes and transportation methods are used in several contexts. Only modes are used in route plans, while both

modes and transportation methods are used when setting up shipping carriers and carrier services. No explicit

relationship or hierarchy exists between modes and transportation methods.

To create a mode, follow these steps:

1. Go to Transpor tation management > Setup > Carr iers > ModeTranspor tation management > Setup > Carr iers > Mode.

2. Select NewNew  to create a new mode.

3. Enter a unique ID and a descriptive name for the mode.

4. Close the page.

To create a transportation method, follow these steps:

1. Go to Transpor tation management > Setup > Carr iers > Transpor tation methodsTranspor tation management > Setup > Carr iers > Transpor tation methods .

2. Select NewNew  to create a new transportation method.

3. Enter a unique ID and descriptive name for the transportation method.

4. Close the page.
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Create a number sequence for a pro number

Link a number sequence to a shipping carrier

NOTENOTE

Use the Number sequencesNumber sequences  page in the transportation management module to set up various pro numbers.

Pro numbers are used by carriers to organize and track the progress of each shipment.

To create a number sequence for a pro number, do the following:

1. Go to Transpor tation management > Setup > Carr iers > Number sequencesTranspor tation management > Setup > Carr iers > Number sequences .

2. Select NewNew  to create a new number sequence.

3. Enter a unique ID and descriptive name for the number sequence.

4. In the Number sequence typeNumber sequence type field, Pro number is the only option.

5. In the Check digitCheck digit field, Check digit is the only option and is set up as a generic engine.

6. On the SequenceSequence FastTab, provide information about the sequence.

7. Close the page.

To link a number sequence to a carrier, do the following:

1. Go to Transpor tation management > Setup > Carr iers > Shipping carr iersTranspor tation management > Setup > Carr iers > Shipping carr iers .

2. Select a shipping carrier.

3. Select EditEdit.

4. On the Over viewOver view  FastTab, select an option in the Pro number sequencePro number sequence field.

5. Close the page.
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Create a transportation status

Map a transportation status to a carrier status

NOTENOTE

Set up master codes for transportation statuses to interpret codes that are provided by your shipping carriers.

This lets you integrate with shipping carriers to provide a status. The transportation status that you provide for a

transportation master status code can help you track the status of a load, shipment, or container. The specific

transportation status for a load, shipment, or container can only be updated through data integration and not

manually through the user interface.

To create a transportation status, follow these steps:

1. Go to Transpor tation management > Setup > Transpor tation status mastersTranspor tation management > Setup > Transpor tation status masters .

2. Select NewNew  to create a transportation status master.

3. In the Transpor tation status masterTranspor tation status master  field, enter a unique code for the transportation status.

4. In the Transpor tation typeTranspor tation type field, select either Shipping carrier or Hub as the type of transportation.

5. Enter a name and transportation status.

6. Close the page.

To map a transportation status to a carrier status, follow these steps:

1. Go to Transpor tation management > Setup > Carr iers > Carr ier  transpor tation statusTranspor tation management > Setup > Carr iers > Carr ier  transpor tation status .

2. Select NewNew  to map a code from a shipping carrier to a transportation status master code.

3. Select the unique ID for the shipping carrier and the carrier service.

4. Select the transportation status code that you want to map to the selected shipping carrier's code.

5. Enter the external code that is used by the shipping carrier.

6. Close the page.
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NOTENOTE

Transport management lets you divide geographic locations into zones. Dividing locations into zones can help

to:

S implify transpor tation pr icingSimplify transpor tation pr icing – Zone-wise pricing can be simpler than individual location-based

pricing, especially when transportation locations are scattered.

Optimize load planningOptimize load planning – By consolidating loads by zones.

Optimize route planningOptimize route planning – By assigning specific route plans to specific zones.

You define zones based on the metadata field values (such as country, zip code range, or carrier service) that

qualify each zone. Zone definitions aren't required if your transportation pricing doesn't employ a zone concept.
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Create a carrier group

NOTENOTE

A carrier group is a collection of shipping carriers and carrier services. Each carrier group specifies the preferred

sequence for the shipping carriers and carrier services that belong to it.

When multiple shipping carriers and carrier services exist for the same route segment, you can specify a carrier

group instead of a specific shipping carrier and carrier service in the route plan or route guide.

1. Go to Transpor tation management > Setup > Carr iers > Carr ier  groupTranspor tation management > Setup > Carr iers > Carr ier  group.

2. Select NewNew .

3. In the Carr ier  groupCarr ier  group field, enter a unique identifier (ID) for the group.

4. In the NameName field, enter a descriptive name for the group.

5. On the DetailsDetails  FastTab, add a row, and select a shipping carrier and a carrier service for it. Repeat this step

until you've added as many carriers as you require for the group.

6. Close the page.
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Create a load building strategy

Use a load building strategy in the load building workbench

The load building workbench lets you apply load building strategies when you create loads.

You use load building strategies to automatically build loads. This capability can be beneficial in the following

situations:

If you regularly ship a specific set of products, load strategies help save time, because you don't have to build

the same load every time.

If you want to avoid half-full loads to maximize efficiency, load strategies can help fill each load as much as

possible.

A load building strategy class that is named TMSLoadBuildingVolumeStrategy  provides a load building strategy

that is named Volume-based load building strategy. This strategy lets you use the maximum values that are

specified for height and weight in the load template, or you can override the settings by entering new values.

This strategy is the only strategy that is included out of the box. (However, you might have some custom

strategies.)

To use the out-of-box Volume-based load building strategy strategy, select it in the Load building strategyLoad building strategy

field on the Load building workbenchLoad building workbench page (Transpor tation management > Planning > Load buildingTranspor tation management > Planning > Load building

workbenchworkbench).

To create a load building strategy, follow these steps.

1. Go to Transpor tation management > Setup > Load building > Load building strategiesTranspor tation management > Setup > Load building > Load building strategies .

2. On the Action Pane, select Generate class listGenerate class list to make sure that you have the latest versions of all available

classes.

3. On the Action Pane, select NewNew .

4. Enter a unique name for the strategy, select the load building strategy class for it, and enter a description.

5. On the Action Pane, select SaveSave.

6. On the Action Pane, select ParametersParameters .

7. On the Load building strategy parametersLoad building strategy parameters  page, select Volume capacityVolume capacity  in the list, and then, in the

ValueValue field, enter the percentage of the load's total volume capacity that should be applied for the new load

building strategy.

8. Select Weight capacityWeight capacity  in the list, and then, in the ValueValue field, enter the percentage of the load's total

weight capacity that should be applied for the new load building strategy.

9. Close the Load building strategy parametersLoad building strategy parameters  page.

10. Close the Load building strategiesLoad building strategies  page.

You can now assign the load building strategy to a load building template. Alternatively, you can use it directly in

the load planning workbench.

1. Go to Transpor tation management > Planning > Load building workbenchTranspor tation management > Planning > Load building workbench.

2. Follow one of these steps:

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/transportation/tasks/load-building-workbench.md
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Select a strategy in the Load building strategyLoad building strategy  field.

If you've defined a load building template and assigned the load building strategy to it, on the Action

Pane, on the Manage templatesManage templates  tab, select Apply templateApply template. Then, in the Apply load buildingApply load building

templatetemplate drop-down dialog box, select a template in the Load building template nameLoad building template name field.

3. On the Load templates sequenceLoad templates sequence FastTab, select one or more load templates. The workbench will try to

fit the load into these types of containers, in the sequence that is specified here. Typically, you should put

the smallest containers at the top of the list to ensure that the smallest possible container is selected first.

4. On the Action Pane, select Propose loadsPropose loads .

5. Review the proposed loads and proposed load lines.

6. On the Action Pane, select Create loadsCreate loads  to create loads that are based on the source document lines on

the Proposed load linesProposed load lines  FastTab.

7. Close the Load building workbenchLoad building workbench page.
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Set up a load template

Associate a load template with a new load

NOTENOTE

When you create a new load, you can assign a load template. The load template contains information about

equipment, and about measures such as the height, width, depth, and volume of the load.

This topic describes how to set up load templates, and how to associate a load template with a new load.

1. Go to Transpor tation management > Setup > Load Building > Load templateTranspor tation management > Setup > Load Building > Load template.

2. On the Action Pane, select NewNew  to add a new template or EditEdit to edit an existing template.

3. In the row for the new or existing template, set the following fields:

Load template IDLoad template ID – Enter a unique identifier (ID) for the load template.

EquipmentEquipment – Select the equipment that should be used to ship the load.

Load heightLoad height, Load widthLoad width, and Load depthLoad depth – Enter the dimensions of the load.

Max. allowed load volumeMax. allowed load volume and Max. allowed load weightMax. allowed load weight – Enter the maximum allowed volume

and weight of the load.

Maximum allowed gross weightMaximum allowed gross weight – Enter the maximum allowed gross weight of the load. A load's

gross weight includes both its tare weight and its loading weight.

Maximum number of freight pieces allowedMaximum number of freight pieces allowed – Enter the maximum number of freight pieces that

the load can contain.

Stack load on floorStack load on floor  – Select this check box to use floor loading. In a floor loading scenario, boxes are

stacked floor to ceiling and wall to wall inside the container, to maximize capacity.

4. On the Action Pane, select SaveSave.

1. Go to Transpor tation management > Planning > Load planning workbenchTranspor tation management > Planning > Load planning workbench.

2. In the upper part of the page, select one of the following tabs, depending on the type of source document

that you're creating a load for : ShipmentsShipments , Sales linesSales lines , Transfer linesTransfer lines , or Purchase order linesPurchase order lines .

3. Select the specific document to plan the load for.

4. On the Action Pane, on the Supply and demandSupply and demand tab, in the AddAdd group, select To new loadTo new load.

5. In the Load templateLoad template dialog box, in the Load template IDLoad template ID field, select the template to apply.

6. Select OKOK to apply the template.
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Create or edit a rating profile on the Rating profiles page

Create a rating profile directly on the Shipping carriers page

A rating profile resembles a logistics contract (but not a legal contract). It's used to determine transportation

tariffs for loads.

Each rating profile is unique to a shipping carrier. In the profile, you associate the shipping carrier with a rate

master. The rate master defines the rate base assignment and the rate base. The rate base determines the rate of

the carrier.

You can set up a rating profile by using a generic page that shows an overview of all existing rating profiles.

Alternatively, you can set up a rating profile directly from the shipping carrier. In both cases, the information that

you set up for the rating profile is the same.

On the Rating profilesRating profiles  page, you can review all available rating profiles. You can also edit existing profiles and

create new profiles.

1. Go to Transpor tation management > Setup > Rating > Rating profileTranspor tation management > Setup > Rating > Rating profile.

2. On the Action Pane, select NewNew  to add a new rating profile to the grid, or select EditEdit to edit an existing

profile.

3. In the row for the new or existing rating profile, set the following fields:

Rating profileRating profile – Enter a unique identifier (ID) for the rating profile.

NameName – Enter a descriptive name for the rating profile.

Shipping carr ierShipping carr ier  – Select a shipping carrier. The rating profile that you're setting up will also be

shown on the Shipping carr iersShipping carr iers  page for the selected carrier.

S iteSite and WarehouseWarehouse – Select a site and warehouse.

Rate engineRate engine – Select the rate engine for the rating profile.

Rate masterRate master  – Select the rate master for the rating profile. You can use the rate master to define a

rate base type and a rate base. For more information, see Set up rate masters.

Transit time engineTransit time engine – Select the transit time engine for the rating profile.

Carr ier  fuel indexCarr ier  fuel index – Select the carrier fuel index for the rating profile.

Effect star t date and timeEffect star t date and time and Effective end date and timeEffective end date and time – Define the period when the rating

profile should be active.

4. On the Action Pane, select SaveSave.

1. Go to Transpor tation management > Setup > Carr iers > Shipping carr iersTranspor tation management > Setup > Carr iers > Shipping carr iers .

2. Select a shipping carrier in the list.

3. On the Rating profilesRating profiles  FastTab, select NewNew  to create a rating profile.

4. Set the fields for the new rating profile. These fields correspond to the fields on the Rating profilesRating profiles  page, as

described in previous section of this topic.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/transportation/tasks/setup-a-rating-profile.md
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Profiles that are created on the Shipping carriersShipping carriers  page are also shown on the Rating profilesRating profiles  page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Create a fuel index region

Create a fuel index

Create a Carrier fuel index

This guide shows how to create a fuel index region, a fuel index and a carrier fuel index. The fuel index region

specifies which region the fuel index should apply to, and the fuel index specifies a fuel price for a particular

period of time. To reflect the change in fuel prices over time, you can associate multiple fuel indexes with a

carrier. These tasks are normally done by a transportation coordinator. You can use this procedure in demo data

company USMF or using your own data.

1. Go to Transportation management > Setup > Fuel indexes > Fuel index regions.

2. Click New.

3. In the Region field, type a value.

4. In the Name field, type a value.

5. Click Save.

First you have to create the different regions, where you operate and calculate different fuel

surcharges.

1. Go to Transportation management > Setup > Fuel indexes > Fuel indexes.

2. Click New.

3. In the Region field, click the drop-down button to open the lookup.

4. In the list, click the link in the selected row.

5. In the Price per gallon field, enter a number.

6. In the Effective start date and time field, enter a date and time.

7. Click Save.

For the regions you have set up you need to enter the current prices for the fuel.

1. Go to Transportation management > Setup > Fuel indexes > Carrier fuel indexes.

2. Click New.

3. In the Carrier fuel index field, type a value.

4. In the Description field, type a value.

5. Click New.

6. In the Effective start date and time field, enter a date and time.

7. In the PPG From field, enter a number.

8. In the PPG To field, enter a number.

9. In the Percentage field, enter a number.

10. In the Currency field, click the drop-down button to open the lookup.

11. In the list, find and select the desired record.

In this example, you can set PPG From field to 1.95.

In this example you can set the PPG To field to 2.

In this example you can set the percentage to 3.
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12. In the list, click the link in the selected row.

13. Click Save.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Set up a transportation tender
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Select a route

Create the transportation tender

NOTENOTE

This procedure shows how to set up a transportation tender. This is typically done by a transportation

coordinator. You can use this procedure in the USMF demo data company.

1. Go to Transportation management > Planning > Load planning workbench.

2. Clear the Hide shipped and received check box.

3. Select the line with Load ID 00006.

4. Click Rating and routing.

5. Click Routes.

1. Click Transportation tenders.

2. Click New.

3. Expand the General section.

4. In the Requested rates field, enter a number.

5. Click Save.

6. Click Update status.

7. Click Submit.

8. Select a route.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Set up Accessorial assignment

NOTENOTE

This procedure shows how to set up an accessorial assignment. This is typically done by a transportation

coordinator. Before you use this guide you need to run the "Set up hub accessorial charges and accessorial

masters" guide.

1. Go to Transportation management > Setup > Rating > Accessorial assignments.

2. Click New.

3. In the Name field, type a value.

4. Toggle the expansion of the Details section.

5. In the Hub field, click the drop-down button to open the lookup.

6. In the list, select the Hub that you created an accessorial master for when you ran the "Set up hub accessorial

charges and accessorial masters" guide.

7. In the Hub accessorial ID field, click the drop-down button to open the lookup.

8. In the list, click the link in the selected row.

9. Toggle the expansion of the Criteria section.

10. Set the Always apply option to Yes.

11. In the Accessorial assignment level field, select an option.

12. Toggle the expansion of the Calculation section.

13. In the Accessorial fee type field, select 'Flat'.

14. In the Accessorial fee field, enter a number.

15. Click Save.

In the Criteria section you can choose the exact criteria for when the charge should apply, based on the

different values offered here.

The Accessorial fee type determines how to calculate the actual charge. In this example it's a flat

charge.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Set up an appointment for a load
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Select the load

Create an appointment

NOTENOTE

This procedure shows how to set up and plan a dock appointment for a load. This is typically done by a

transportation coordinator. You can use this procedure in the USMF demo data company.

1. Go to Transportation management > Planning > Load planning workbench.

2. Clear the Hide shipped and received check box.

3. In the list, select the load that has a status of Shipped.

4. Click Transportation.

5. Click Appointment scheduling.

1. Click New.

2. In the Appointment rule field, enter or select a value.

3. Click Save.

4. Click Update status.

5. Click Firm.

6. Click Save.

7. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Set up the freight bill type

Set up the freight bill type assignment

Set up the audit master

This procedure shows how to set up data for automatic freight reconciliation. This is typically done by a

warehouse manager. You can use this procedure in demo data company USMF.

1. Go to Transportation management > Setup > Freight reconciliation > Freight bill type.

2. Click New.

3. In the Freight bill type field, type a value.

4. In the Engine assembly field, type 'Microsoft.Dynamics.Ax.Tms.dll'.

5. In the Engine class field, type 'Microsoft.Dynamics.Ax.Tms.Bll.GenericNormalizer'.

6. Click New.

7. In the Description field, choose the value that should match on the freight bill and the carrier invoice.

8. In the Match required field, select 'Yes'.

9. Click Save.

The freight bill type defines how freight bills and carrier invoices should be matched.

This is the standard Transportation management matching engine code library.

This is the standard Transportation management matching engine class.

If you set this field to Yes this means that the value selected in the Description field needs to match on

both the freight bill and the carrier invoice. If you set it to No, the field can be blank on one of these.

1. Close the page.

2. Go to Transportation management > Setup > Freight reconciliation > Freight bill type assignments.

3. Click New.

4. In the Mode field, enter or select a value.

5. In the Shipping carrier field, enter or select a value.

6. In the Freight bill type field, select the freight bill type that you created earlier.

7. Close the page.

The freight bill type assignment is used to specify which freight bill type is used for a particular carrier.

1. Go to Transportation management > Setup > Freight reconciliation > Audit master.

2. Click New.

3. In the Audit master ID field, type a value.

4. In the Shipping carrier field, select the same shipping carrier as you did earlier.

5. In the Freight bill type field, select the freight bill type that you created earlier.

6. Expand the Tolerance section.

7. In the Minimum tolerance level field, enter a number.

The audit master defines the tolerance limits for automatic freight reconciliation. It specifies by how

much the monetary amounts on the freight bill and the carrier invoice can differ and still allow

reconciliation to occur. It also defines how to handle discrepancies.
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8. In the Maximum tolerance level field, enter a number.

9. Expand the Result section.

10. In the Overpayment reason code field, enter or select a value.

11. In the Underpayment reason code field, enter or select a value.

12. Close the page.

If the monetary amounts differ on the freight bill and the carrier invoice, the overpayment and

underpayment reason codes specify the accounts that the difference should be registered on, as long

as the difference is within the tolerance levels.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Set up a hub master

Set up a hub accessorial charge

NOTENOTE

This procedure shows how to create an accessorial master for a hub and use that master to create a hub

accessorial charge. The procedure uses the USMF dataset. This set up will typically be done by a transportation

coordinator.

1. Go to Transportation management > Setup > Rating > Accessorial masters.

2. Click New.

3. In the Accessorial master field, type a value.

4. In the Name field, type a value.

5. In the Accessorial type field, select 'Hub'.

6. Click Save.

7. Close the page.

1. Go to Transportation management > Setup > Rating > Hub accessorial charges.

2. Click New.

3. In the Hub accessorial ID field, type a value.

4. In the Hub field, click the drop-down button to open the lookup.

5. In the list, find and select the desired record.

6. In the Hub position field, select an option.

7. In the Accessorial master field, click the drop-down button to open the lookup.

8. In the list, click the link in the selected row.

9. Click Save.

10. Close the page.

You can either create the charge as a pickup or drop-off. Depending on your selection the charge will

be applied to the corresponding transportation segment on your route.

Select the master you just created.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Set up break master

Set up rate master

Set up rate base

This procedure shows you how to set up a rate master. The logistic manager usually sets up rate masters,

depending on the contracts signed with the carriers. In this scenario you will set up a rate master for an air

carrier. The demo data company used to create this procedure is USMF.

1. Go to Transpor tation management > Setup > Rating > Break masterTranspor tation management > Setup > Rating > Break master . Break masters are used to

define the pricing structure and its breakpoints. The pricing structure uses tiered pricing that is based on

physical dimensions.

2. Select NewNew .

3. In the Break masterBreak master  field, enter a value.

4. In the NameName field, enter a value.

5. In the Data typeData type field, select the data type.

6. In the ComparisonComparison field, enter the kind of comparison requested (using operators).

7. In the Break unitBreak unit field, enter the break unit.

8. In the DetailsDetails  section, create as many breaks as needed for the pricing structure.

9. Select SaveSave.

1. Go to Transpor tation management > Setup > Rating > Rate masterTranspor tation management > Setup > Rating > Rate master .

2. Select NewNew .

3. In the Rate masterRate master  field, type a value.

4. In the NameName field, type a value.

5. In the Rating metadata IDRating metadata ID field, select the drop-down button to open the lookup. The rating metadata ID

will determine the data needed for the rate master, as it defines the metadata expected by the transportation

management engine using this rate master.

6. For this example, select the P2P option. This is already defined in the demo data.

7. In the list, select the link in the selected row.

8. Select SaveSave.

1. Select Rate baseRate base.

2. Select NewNew .

3. In the Rate baseRate base field, type a value.

4. In the NameName field, type a value.

5. In the Break masterBreak master  field, select the drop-down button to open the lookup.

6. For this example, use weight. This is already defined in the demo data.

The rate base determines the rate of the carrier, and can be used to set up a tariff structure as it

structures the rates in the breakpoints defined in the break master.

Break masters are used to define the pricing structure and its breakpoints. The pricing structure uses

tiered pricing that is based on physical dimensions.
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7. In the list, select the link in the highlighted row.

8. Expand the DetailsDetails  section.

9. Select NewNew .

10. In the Drop-off Postal Code FromDrop-off Postal Code From field, type "30301".

11. In the Drop-off Postal Code ToDrop-off Postal Code To field, type "30318".

12. In the Drop-off Countr y RegionDrop-off Countr y Region field, type "USA".

13. In the <1.00 Lbs<1.00 Lbs  field, type "100".

14. In the <5.00 Lbs<5.00 Lbs  field, type "300".

15. In the <20.00 Lbs<20.00 Lbs  field, type "500".

16. In the <100.00 Lbs<100.00 Lbs  field, type "1000".

17. In the <1,000.00 Lbs<1,000.00 Lbs  field, type "3000".

18. Select SaveSave.

19. Close the page.

Insert the rate per pounds if the total weight of the load is less than 1 pound.

Insert the rate per pounds if the total weight of the load is less than 5 pounds.

Insert the rate per pounds if the total weight of the load is less than 20 pounds.

Insert the rate per pounds if the total weight of the load is less than 100 pounds.

Insert the rate per pounds if the total weight of the load is less than 1000 pounds.

1. Expand the Rate base assignmentsRate base assignments  section.

2. Select NewNew .

3. In the NameName field, type a value.

4. In the Rate baseRate base field, select the drop-down button to open the lookup.

5. In the list, select the link in the highlighted row.

6. In the Ser viceSer vice field, select the drop-down button to open the lookup.

7. In the list, find and select the desired record.

8. In the list, select the link in the highlighted row.

9. In the Pick-up Postal CodePick-up Postal Code field, type "98052".

10. In the Pick-up Countr y RegionPick-up Countr y Region field, type "USA".

11. Select SaveSave.

You can have several rate base assignments for each rate master. This makes it possible to create

several different price points for each carrier depending on destinations, services, or different rate

bases. In this procedure you will only create one rate base assignment.

Specify which postal code this rate base assignment should be valid from.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create a new shipping carrier

Fill in the general information for the shipping carrier

Create the necessary services for the shipping carrier

Set up the address for the carrier (optional)

Set up the rating profile for the shipping carrier

This topic shows how to set up a shipping carrier and define details such as service, shipment mode,

transportation tender, transportation constraints, and shipping rate. A transportation coordinator can then

assign a shipping carrier to an inbound or outbound load.

1. Go to Navigation pane > Modules > Transpor tation management > Setup > Carr iers > ShippingNavigation pane > Modules > Transpor tation management > Setup > Carr iers > Shipping

carr ierscarr iers .

2. Select NewNew  on the Action Pane.

3. In the Shipping carr ierShipping carr ier  field, type a value.

4. In the NameName field, type a value.

5. In the ModeMode field, select an option from the drop-down menu.

1. Toggle the expansion of the Over viewOver view  section.

2. Check or uncheck the Activate shipping carr ierActivate shipping carr ier  checkbox.

3. In the Vendor accountVendor account field, select an option from the drop-down menu. Select the vendor account to

assign the shipping carrier to.

4. In the Transpor tation tender typeTranspor tation tender type field, select an option. Select ManualManual  to use the Transportation Tender

page, or select EDIEDI to update the tender by using Electronic Data Interchange (EDI).

5. Check or uncheck the Activate carr ier  ratingActivate carr ier  rating checkbox.

1. Toggle the expansion of the Ser vicesSer vices  section.

2. Select NewNew .

3. In the Carr ier  ser viceCarr ier  ser vice field, type a value.

4. In the NameName field, type a value.

5. In the Transpor tation methodTranspor tation method field, select an option from the drop-down menu.

1. Toggle the expansion of the AddressesAddresses  section.

2. Select NewNew .

3. In the Name or descr iptionName or descr iption field, type a value.

4. In the Countr y/regionCountr y/region field, select an option from the drop-down menu.

5. In the ZIP/postal codeZIP/postal code field, select an option from the drop-down menu.

6. In the StreetStreet field, type a value.

7. Select OKOK.

1. Toggle the expansion of the Rating profilesRating profiles  section.
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2. Select NewNew .

3. In the Rating profileRating profile field, type a value.

4. In the NameName field, type a value.

5. In the S iteSite field, select an option from the drop-down menu.

6. In the WarehouseWarehouse field, select an option from the drop-down menu.

7. In the Rate engineRate engine field, select an option from the drop-down menu. Select the Rate engine that is in

accordance with the contract that you have with the carrier.

8. In the Rate masterRate master  field, select an option from the drop-down menu.

9. In the Transit time engineTransit time engine field, select an option from the drop-down menu.

10. Select SaveSave.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Create an item constaint

NOTENOTE

This procedure will set up a transportation constraint to prevent a selected item from being transported through

a selected hub. This task would typically be carried out by a Transportation coordinator. You can use this

procedure in the USMF demo data company or on your own data.

1. Go to Constraints.

2. Click New.

3. In the Item constraint field, type a value.

4. In the Name field, type a value.

5. In the Site field, enter or select a value.

6. In the Warehouse field, enter or select a value.

7. In the Item number field, enter or select a value.

8. In the Hub field, enter or select a value.

9. In the Constraint action field, select an option.

10. Click Save.

11. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Get started

Warehouse management processes

The Warehouse management module lets you manage warehouse processes in manufacturing, distribution, and

retail companies. This module has a wide range of features to support the warehouse facility at an optimal level,

at any time. Warehouse management is fully integrated with other business processes such as transportation,

manufacturing, quality control, purchase, transfer, sales, and returns.

To start working with Warehouse management, you need to complete the setup of the general warehouse

parameters to support the business processes of your company.

Go to the Warehouse management parametersWarehouse management parameters  page under Warehouse managementWarehouse management > SetupSetup to set

up general warehouse parameters.

You must configure components for inbound and outbound warehouse process workflows according to

business requirements. The most important components that you must configure are wave templates, work

templates, work pools, and location directives.

Warehouse configuration overview

Control warehouse work by using work templates and location directives

Set up mobile devices for warehouse work

Set up a location directive for purchase order put-away

Set up a work template for purchase orders

Integrated support for source documents for sales orders, returns, transfer orders, production orders, and

kanban

Flexible, inbound and outbound material workflow support based on queries

Full integration with the Manufacturing and Transportation offerings

Full control of location stocking limits and location volumetrics

Inventory properties controlled by inventory status

Full batch and serial item support

Various item receiving capabilities

Multiple picking strategies

Out-of-the-box support for the next generation of barcode scanners

Pallet/container types for warehouse processes

Advanced counting capabilities

Label printing and label routing with Zebra ZPL support

Business intelligence integration into Power BI

Manual and automatic movement of inventory

Fully-integrated quality control (QMS)

Full traceability of workers' material handling

Outbound wave processing

Manual packing and automatic containerization support
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BlogsBlogs
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Cluster picking

Simple cross docking

Go to the Microsoft Dynamics 365 Roadmap to see what new features have been released and what new

features are in development.

You can find opinions, news, and other information about Warehouse management and other solutions on the

Microsoft Dynamics 365 blog.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Overview: How inbound loads are created, registered, and received

This topic describes the warehouse handling process for inbound loads for purchase orders.

For each inbound load, your system should already include a related sales order, and it might also contain a

related load specification and/or transportation plan. For more information about how to create and manage

inbound loads, see Business process: Planning transportation for inbound loads.

The following illustration shows the typical flow for handling inbound loads that have purchase order quantities

when they arrive at your warehouse.

1. The vendor confirms the purchase order.The vendor confirms the purchase order.

The process begins when a purchase order is entered into the system and then delivered to a vendor, who

confirms the order. The purchase order must exist before you can create an inbound load record.

However, you can create the inbound load even if the order hasn't been confirmed. For more information,

see Approve and confirm purchase orders.

2. An inbound load record is created to plan the arr ival and its contents.An inbound load record is created to plan the arr ival and its contents.

The inbound load record represents a vendor shipment of one or more purchase orders. The load is

expected to arrive at the warehouse as one physical transportation unit (such as a truckload). The

inbound load record is used for planning purposes and lets the logistics coordinator track the load's

progress from the vendor. It's also used to register order line quantities and manage progress through

warehouse operations, such as arrival and put-away work. Loads can be created either automatically or

manually, and they can be based on either a purchase order or an advanced shipment notice (ASN) from

the vendor. For more information, see Create or modify an inbound load.

3. The vendor confirms load dispatch.The vendor confirms load dispatch.

When the vendor dispatches the load, the logistics coordinator at the receiving warehouse confirms the

load shipment. If the receiving company is using the Transpor tation managementTranspor tation management module, inbound

shipment confirmation will trigger other load management processes that are associated with the

inbound loads. For more information, see Confirm a load for shipping.

4. The load arr ives at the warehouse, and workers register quantities.The load arr ives at the warehouse, and workers register quantities.

When a truckload arrives at the warehouse receiving dock, warehouse workers register the load

quantities. When the Warehouse managementWarehouse management module is used, workers do the registration by using

mobile devices. For more information, see Product receipt against purchase orders - registration and the

Register item quantities that arrive on an inbound load section.

5. Registered load quantities are posted against purchase orders.Registered load quantities are posted against purchase orders.
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 Register item quantities that arrive on an inbound load

After the load quantities have been registered as arrived, those quantities must be product receipt–posted

to the company's inventory ledger to record the physical stock increase. For more information, see

Product receipt against purchase orders - product receipt and Post registered product quantities against

purchase orders.

Microsoft Dynamics 365 Supply Chain Management supports several operational approaches to recording the

arrival of ordered products. Therefore, you can configure the system to match your specific business

requirements. This section describes how to register incoming item quantities by using a mobile device when

advanced warehouse management is turned on in the system. However, there is an alternative flow that is based

on using the item arrival journal instead of a mobile device. For more information about that flow, see Register

items for an advanced warehousing enabled item using an item arrival journal.

When an inbound load first arrives at the warehouse, warehouse workers must register the item quantities that

are included in the shipment. Typically, they use handheld scanners. This workflow is available only if the

following items are present in the system:

NOTENOTE

An inbound load record that descr ibes the item quantities that are expected in the shipmentAn inbound load record that descr ibes the item quantities that are expected in the shipment

Typically, the vendor confirms the inbound load record before the shipment arrives at the warehouse.

Therefore, the load has a status of Shipped. However, warehouse workers can also register items

quantities for loads that have a status of Open or Received.

A mobile device menu that is configured to suppor t load receivingA mobile device menu that is configured to suppor t load receiving

The warehouse app for mobile devices supports the following work creation processes:

Load item receiving

Load item receiving and put away

Mixed license plate receiving, where the Source document line identification methodSource document line identification method field for

the mobile device menu item is set to Load item receiving. For more information, see Mixed license

plate receiving.

Mixed license plate receiving and put away, where the Source document line identificationSource document line identification

methodmethod field for the mobile device menu item is set to Load item receiving. For more information,

see Mixed license plate receiving.

Regardless of the process, the system will generate work to take quantities that are registered in the receiving

location and put them away in the regular storage location. When the Load item receiving and put away or Mixed

license plate receiving and put away process is used, the worker who registered the load quantity will also be

instructed by the device to do the put-away work as part of the registration task. By contrast, for the Load item

receiving and Mixed license plate receiving processes, the assumption is that put-away work will be done

separately from the registration task.

A work template that defines pick and put work for incoming loadsA work template that defines pick and put work for incoming loads

This item is related to the previous items. You must have at least one work template for the Purchase

order work order type, and it must contain a set of pick/put work types.

The mobile device guides the warehouse receiving clerk through the flow for load quantity registration. At a

minimum, this flow includes the following steps for each load ID:

1. Enter the load ID.

2. Enter the item number for a received item.
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Load The Work created quantityWork created quantity  field on
the load line is updated to show the
registered quantity.

The Load statusLoad status value remains
Shipped or Open if no shipment
confirmation has been run for the load.
If at least one line of put-away work
has been started, it's changed to In
process.

Inventory transaction of a purchase
order that associated load quantities
have been registered for

The ability to link between the
purchase order inventory transaction
and the quantities that are registered
against the load was introduced in
version 10.0.9 as an optional feature
that was named Associate purchase
order inventory transactions with load.
This feature is especially beneficial for
operational flows where a single order
of purchased goods is delivered as
multiple loads, or when a load contains
quantities for multiple purchase orders.

Warehouse put-away Work is created based on a work
template, to instruct the worker to
move the registered quantities from
the receiving location to a regular
storage location.

The choice of the storage location is
controlled by the Put location directive.
If no location directive has been
defined, the put away location on the
work is empty.

3. Enter the quantity of that item number that is received.

4. Enter the license plate number for the item's initial location, if the system isn't set up to generate this number

automatically.

5. Tap OKOK.

After the worker completes these steps, the system makes the following updates on the appropriate entities,

provided that the purchase order line quantity arrived on one load and all load quantities have been registered:

The following fields are updated:

The ReceiptReceipt  field is set to 
Registered.
The LocationLocation field is updated
with the receiving dock location
code. (This code is specified in
the Default receipt locationDefault receipt location
field for each warehouse.)

The License plateLicense plate field is
updated with the license plate
number that was entered or
generated during the
registration.

The Load IDLoad ID field is updated
with the number of the load
that the quantity has been
registered against. (See the
note.)

Note that warehouse workers can register the receipt of a purchase order with one or more associated loads

without using the Load item receiving process. The following methods are available:

On the mobile device:On the mobile device: Use the Purchase order line receiving and Purchase order line receiving and put

away processes. (If more than one load exists for the purchase order line quantity, the worker can't use the

Purchase order line receiving process. Instead, the worker will be instructed to use the device action that is

associated with the Load item receiving process.)

On the client:On the client: Use the item arrival journal.

On the client:On the client: Use the RegistrationRegistration action that can be accessed from the purchase order line.



  

NOTENOTE

Handle discrepancies during registration of inbound load quantitiesHandle discrepancies during registration of inbound load quantities

Load under-receivingLoad under-receiving

Load over-receivingLoad over-receiving

VA L UEVA L UE DESC RIP T IO NDESC RIP T IO N

Allow Workers can register the receipt of quantities that exceed
the remaining unregistered quantity for a selected load, but
only if the total registered quantity doesn't exceed the
quantity of the purchase order line that is associated with
the load (after adjustment for the overdelivery percentage).

If the purchase order receipt is registered by using any of the preceding methods, no link is created between the purchase

order inventory transaction and the load, even when the Associate purchase order inventory transactions with load

feature is turned on. One exception to this rule is when you use the Purchase order line receivingPurchase order line receiving option, and only

one load has a status other than Received for the order line.

Warehouse workers can do a partial load quantity receipt registration. Each partial load quantity receipt then

creates a separate inventory transaction that has a receipt status of Registered for the registered quantity, and

the lot ID refers to the originating purchase order line.

When a load arrives, if the item quantities are less than the quantities that are stated on the load record,

warehouse receiving personnel can work directly in the client to acknowledge this discrepancy by reducing the

quantity on the load line so that it matches the actual quantity that arrived and was registered.

Over-receiving occurs when a load arrives, and the item quantities exceed the expected load line quantity. You

can control whether and to what degree over-receiving is allowed during load registration.

Use the Load over receiptLoad over receipt field for the relevant mobile device menu items to control what occurs when a

warehouse worker tries to register an overdelivery. This field is available for mobile device menu items that use

the following types of work creation processes:

Load item receiving

Load item receiving and put away

Mixed license plate receiving (when the Source document line identification methodSource document line identification method field is set to Load

item receiving)

Mixed license plate receiving and put-away (when the Source document line identification methodSource document line identification method field

is set to Load item receiving)

The following table explains the options that are available for the Load over receiptLoad over receipt field.



Block

Block for closed loads only Workers can over-receive load line quantities for open loads,
but not for loads that have a status of Received.

VA L UEVA L UE DESC RIP T IO NDESC RIP T IO N

NOTENOTE

Put away the registered quantitiesPut away the registered quantities

Workers can't register the receipt of quantities that
exceed the remaining unregistered quantity for a
selected load (after adjustment for the overdelivery
percentage). A worker who tries to do register the
receipts will receive an error and won't be able to
continue until he or she registers a quantity that is equal
to or less than the remaining unregistered load quantity.

By default, the value of the overdelivery percentage on a
load line is copied from the associated purchase order
line. When the Load over receiptLoad over receipt  field is set to Block,
the system uses the overdelivery percentage value to
calculate the total quantity that can be registered for a
load line. However, that value can be overwritten for
individual loads as required. This behavior becomes
relevant during receiving flows where some or all of the
excess quantity that represents the order line
overdelivery percentage is distributed disproportionally
across multiple loads. Here is an example scenario:

There are multiple loads for one purchase order line.

The purchase order line has an overdelivery
percentage that is more than 0 (zero).

Quantities have already been registered against one
or more loads without taking the overdelivery
percentage into account.

The overdelivery quantity arrives on the last load.

In this scenario, a mobile device can be used to register
the excess quantity for the last load only if the
warehouse supervisor increases the overdelivery
percentage for the relevant load line from the default
value to a value that is large enough so that the full
overdelivery can be registered with the final load.

The default value of the Load over receiptLoad over receipt  field is Allow. When this value is used, the behavior matches the standard

behavior that was available before the Over receipt of load quantities feature was introduced in version 10.0.11.

When registration is completed on the mobile device, the Quantity receipt registration action updates the

inventory and warehouse records to indicate that the quantities are now in the receiving dock location and

available for reservation. However, a company's warehouse operations typically require that the quantities be

moved from the receiving dock to the regular warehouse storage, so that the subsequent picking processes can

occur. Instructions for the put-away are captured in the put-away work that is automatically generated when the

inbound load is registered as received.

When the warehouse worker has completed the put-away work, the system records and tracks the result by

updating updates several entities, as summarized in the following table.
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Load The Load statusLoad status value is changed to
In process when the worker starts the
put-away task for at least one line of
put-away work.

Inventory transactions of work that
associated quantities have been put
away for

The ReceiptReceipt  and LocationLocation fields, and
other relevant fields, are updated to
reflect the movement from the
receiving location to the storage
location.

The Receipt stateReceipt state value of the
purchase order inventory transaction
remains Registered.

Warehouse put-away The Work statusWork status value is changed to
Closed.

Post registered product quantities against purchase orders

Post registered quantities from the Load pagePost registered quantities from the Load page

The following fields are updated:

The Load statusLoad status value is
changed to In process.

The Work statusWork status value is
changed to 
100.00% of work completed.

After inbound product quantities are registered in the system, they become available for reservation in

connection with sales and other outbound and internal operations. However, the system doesn't yet update the

inventory (interim) accounts. This update can occur only when the operations team posts the registered product

receipts.

To open a page where they can post a product receipt, members of the operations team can follow any one of

these steps:

Open the relevant load record, and then select the Product receiptProduct receipt action.

Go to Warehouse management > Periodic tasks > Update product receiptsWarehouse management > Periodic tasks > Update product receipts , and then, in the LoadLoad

IDID field, specify the load to post.

Open the relevant purchase order, and then select the Product receiptProduct receipt action.

Go to Procurement and sourcing > Purchase orders > Receiving products > Posting productProcurement and sourcing > Purchase orders > Receiving products > Posting product

receipt jobreceipt job.

The Product receiptProduct receipt action that is available on the LoadLoad page (and on the equivalent page for the update job,

the Update product receiptsUpdate product receipts  page) can update product receipt quantities only on purchase order quantities

that have a status of Registered. However, the Product receiptProduct receipt action that is available on the Purchase orderPurchase order

page can include quantities in both processing statuses (Ordered and Registered). It can also control the scope

of product receipt posting through additional parameters, such as Receive now quantity and Registered quantity

and services.

Only orders that have a status of Confirmed can be product receipt–posted. For non-confirmed purchase orders,

the Product receiptProduct receipt action will appear as unavailable.

To product receipt–post registered quantities from the LoadLoad page, the following prerequisites must be in place:

The load must have at least one quantity unit that has a status of Registered.

The load status must be Shipped.

The purchase order that is associated with the load must have a status of Confirmed.



NOTENOTE

NOTENOTE

V E R S I O NV E R S I O N C A L C U L AT I O NC A L C U L AT I O N

Versions before version 10.0.10, and newer versions where
the Allow multiple product receipt per load feature isn't
turned on

The line quantity is the total of all registered quantities for
that purchase order line, regardless of whether registration
was done over multiple loads, independently of the load,
from a mobile device, or from the client.

Version 10.0.10 and later, where the Allow multiple product
receipt per load feature is turned on

The line quantity is the total of all registered quantities for the
load record that the Product receip t pos tingProduct receip t pos ting  action was
initiated from.

EN T IT YEN T IT Y UP DAT ESUP DAT ES

Inventory transaction of the purchase order for which line
quantities have been included in the posting scope

Load that the user posted the product receipt from Updates to the loads will depend on the version that is used
and the setting of the Allow multiple product receiptAllow multiple product receipt
per loadper load field. The rules are described in the table that
appears later in this section.

If the load status hasn't been set to Shipped, the system will automatically confirm the load before it runs the product

receipt update. (The load status is set to Shipped when a user registers the load's inbound shipment.)

To product receipt–post the arrival registrations that are associated with a selected load, the worker selects the

Product receiptProduct receipt action on the LoadLoad page. The page that is opened has the following key details:

The QuantityQuantity  field in the ParametersParameters  section on the SettingsSettings  tab shows the registered quantity. No other

options are available here.

The grid on the Over viewOver view  FastTab lists all the purchase orders that are included in the selected load.

The grid on the L inesLines  FastTab lists all the order lines that have a registered quantity.

Quantities for order lines that appear on the LineLine tab are calculated differently, depending on whether the Allow multiple

product receipt per load feature is available and turned on in your version of Supply Chain Management.

When the user selects OKOK to confirm product receipt posting, the system does the following key updates on

appropriate entities.

The following fields are updated (but note that there are
also multiple other updates):

The ReceiptReceipt  field is set to Received.

The Physical datePhysical date field is updated with the date of
the posting.

The Allow multiple product receipt per loadAllow multiple product receipt per load field lets companies choose an inbound load receiving policy.

Depending on their operational flows, companies might choose to allow or disallow multiple product receipt

postings for the same load. We recommend that the logistics manager set the Allow multiple productAllow multiple product

receipt per loadreceipt per load field to one of the following values:

NoNo – Select this value if warehouse receiving clerks always register all order quantities that arrive with each

load within a designated time frame. If any load quantities aren't registered, the system assumes that they

didn't arrive or were not on the load, and therefore should not be considered part of the load. The product

receipt posting that is run from a load uses the same assumption. In addition to product receipt–updating all



A L LO W  M ULT IP L EA L LO W  M ULT IP L E
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When this field isn't
available (versions before
10.0.10)

Received If multiple loads exist for
the order line's registered
quantity, only the status of
the load that the receipt
was posted from is updated
to Received.

No Received

Yes No updates Received, if the total
registered load quantity is
equal to or more than the
load quantity

Yes No updates Shipped or In process, if the
total registered load
quantity is less than the
load quantity

the registered quantities (its main function), it declares the load complete and closed for additional

processing. In this case, all load line quantities are automatically updated to the registered quantities, load

lines that have no registered quantities are deleted, and the load status is changed to Received.

YesYes  – Select this value if warehouse receiving clerks require more time to register all the quantities on the

load that arrived, but, in the meantime, you must product receipt–post the quantities that have already been

registered. In this case, the logistics manager will want to keep a load open even after the product receipt

posting job is run, so that remaining load quantities can be registered and product receipt–updated to the

ledger on an ongoing basis.

PromptPrompt – Select this value if your load receiving practices are mixed, and a decision is required each time

that product receipt posting is run.

The following table summarizes the effects of the Allow multiple product receipt per loadAllow multiple product receipt per load setting.

The load quantity is set
so that it equals the
registered quantity.

If the load quantity is
updated to 0 (zero),
which means that no
registration has been
done, the load line is
deleted.

If there are no load
lines on the load, the
load is deleted.

The load quantity is set
so that it equals the
registered quantity that
is associated with the
load ID.

If no load ID is recorded
for the inventory
transaction, the
behavior matches the
behavior in versions
before 10.0.10.

After the Load statusLoad status  field is set to Received, no more product receipt postings can be done for that load.

However, the worker can register the remaining order quantity against the received load under the following

conditions. (For more information, see the Load over-receiving section earlier in this topic.)



Post registered quantities from the Purchase order pagePost registered quantities from the Purchase order page

NOTENOTE
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Inventory transaction of the purchase order for which line
quantities have been included in the posting scope

Load Updates to the loads depend on whether the AllowAllow
multiple product receipt per loadmultiple product receipt per load field is available and
enabled. The rules are described in the next table.

A L LO W  M ULT IP L EA L LO W  M ULT IP L E
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When this field is either
disabled or unavailable (in
versions before 10.0.10)

No updates No updates are done. (The
status remains Open,
Shipped, or In process.)

Because the product receipt
posting is initiated from a
purchase order, the
updating logic doesn't have
information about the
association between the
registered quantities within
its scope and the loads that
the registration was
recorded against. Therefore,
it can't select the load for
the status update.

The version of Supply Chain Management is older than version 10.0.11.

The Over receipt of load quantities feature is turned on, and the Load line quantity over receiptLoad line quantity over receipt field on

the mobile device menu item for the load item receiving action is set to Allow.

To product receipt–post additional registered load quantities against a load that has a status of Received, the

user must run the posting action from the associated purchase order.

To product receipt–post registered quantities from the Purchase orderPurchase order  page, the user completes the following

tasks before he or she selects the Product receiptProduct receipt action:

Set the QuantityQuantity  field in the ParametersParameters  section on the SettingsSettings  tab to Registered quantity.

In the Product receiptProduct receipt field, enter the numbers of the purchase orders that are included in the posting.

The line quantity that will be included in the posting scope is the total of all registered quantities for the order line,

regardless of whether quantity registration has been done over multiple loads, independently of the load, from a mobile

device, or from the client. The same rule applies when product receipt posting is run from a load, if it's done where the

Allow multiple product receipt per loadAllow multiple product receipt per load field either isn't available or isn't enabled.

When the user selects OKOK to confirm product receipt posting, the system does the following key updates on

appropriate entities.

The following fields are updated (but note that there are
also multiple other updates):

The ReceiptReceipt  field is set to Received.

The Physical datePhysical date field is updated with the date of
the product receipt posting action.

The following table summarizes the effects of the Allow multiple product receipt per loadAllow multiple product receipt per load setting.



Enabled No updates
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Select the appropriate product receipt posting option for your logistics operationsSelect the appropriate product receipt posting option for your logistics operations

NOTENOTE

Example scenarios
Prepare your system to run the sample scenariosPrepare your system to run the sample scenarios

Turn on the required featuresTurn on the required features

One of the following
actions occurs:

The status is
changed to Received
if the total received
and purchased
quantities of the
purchase order
inventory
transactions are
more than or equal
to the quantity of
the load that they
are associated with.

The status remains 
Open, Shipped, or 
In process if the
previous condition
isn't met for all the
lines in the load.

As was previously described, the system offers two product receipt posting options. The options can be accessed

in the following places:

On the LoadLoad page, or from the Warehouse management > Periodic tasksWarehouse management > Periodic tasks  menu as an update job

On the Purchase orderPurchase order  page, or from the Procurement and sourcing > Purchase orders > ReceivingProcurement and sourcing > Purchase orders > Receiving

productsproducts  menu as an update job

Companies that use loads to plan and manage transportation and warehouse handling of their inbound orders

are advised to use the following functions, which are designed to work with loads:

Load item receivingLoad item receiving actions on their warehouse mobile devices, to register the product quantity arrival

against the load

Product receipt postingProduct receipt posting actions that are initiated from a load, to update the inventory ledger

Other quantity registration and product receipt posting functions can be used to support the corresponding inbound

operational processes. However, if you use them interchangeably with or instead of the dedicated load-focused functions,

you might compromise the data accuracy of the load records and therefore the seamlessness of the load management

flows.

To work through the sample scenarios that are described in this section, you must first make sure that all the

required features are turned on in your system. The required demo data must also be available in the system.

These scenarios require the Multiple product receipt postings per load feature and its prerequisite feature.



Enable sample dataEnable sample data

Add a menu item for receiving load items when a mobile device is usedAdd a menu item for receiving load items when a mobile device is used

Example scenario 1: Register a load where some items are missingExample scenario 1: Register a load where some items are missing

Admins can turn on those features by following these steps.

1. Open the Feature managementFeature management workspace. (For complete details about how to find and use this

workspace, see Feature management overview.)

2. Turn on the Associate purchase order inventory transactions with load feature, which is listed in the

following way:

Module:Module: Warehouse management

Feature name:Feature name: Associate purchase order inventory transactions with load

3. Turn on the Multiple product receipt postings per load feature, which is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Multiple product receipt postings per load

To work through these scenarios by using the specified sample records and values, you must be using a system

where the standard demo data is installed. You must also select the USMFUSMF legal entity before you begin.

Before warehouse receiving clerks can use a mobile device to register inbound inventory that is linked to a load,

you must create a mobile device menu item for that purpose.

In this section, you will create a mobile device menu item and add it to an existing menu. A warehouse worker

can then select the menu item in the warehouse app.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items , and

make sure that your mobile device menu includes a menu item that has the following settings:

Mode:Mode: Work

Work creation process:Work creation process: Load item receiving

Generate license plate:Generate license plate: Yes

You can leave all other settings at their default values.

For more information about how to set up mobile device menu items, see Set up mobile devices for

warehouse work.

2. After you've finished setting up the menu item, go to Warehouse management > Setup > MobileWarehouse management > Setup > Mobile

device > Mobile device menudevice > Mobile device menu, and add it to the menu structure for your mobile devices.

This scenario shows how to register quantities for an inbound load where not all the expected quantities are

present. It then shows how to post the product receipt for the purchase order.



Create a load to plan receipt of a purchase orderCreate a load to plan receipt of a purchase order

Register receipt of the quantities that arrived on the loadRegister receipt of the quantities that arrived on the load

In this procedure, you will manually create a purchase order and an associated load. You will then update the

load to simulate that it has been shipped from the vendor (which updates the load status). Warehouse planners

can then filter loads by Load statusLoad status  to find expected incoming loads.

1. Go to Procurement and sourcing > Purchase orders > All purchase ordersProcurement and sourcing > Purchase orders > All purchase orders .

2. Select NewNew .

3. In Create purchase orderCreate purchase order  dialog box, set the Vendor accountVendor account field to 1001.

4. Select OKOK to close the dialog box and create the purchase order.

5. The new purchase order already includes a line under Purchase order linesPurchase order lines . Set the following values

for this line:

Item number :Item number : A0001

Warehouse:Warehouse: 24

Quantity:Quantity: 10

6. On the Action Pane, on the PurchasePurchase tab, select Actions > ConfirmActions > Confirm . The order status is now Confirmed.

7. On the Action Pane, on the WarehouseWarehouse tab, select Actions > Load planning workbenchActions > Load planning workbench.

8. On the Load planning workbenchLoad planning workbench page, on the Action Pane, on the Supply and demandSupply and demand tab, select

Add > To new loadAdd > To new load.

9. In the Load template assignmentLoad template assignment dialog box, set the Load template IDLoad template ID field to 20' Container.

10. Select OKOK to close the dialog box and return to the workbench.

11. In the LoadsLoads  section, select Load IDLoad ID to open the newly created load.

12. Review the load header and line details, and notice the following points:

On the LoadLoad FastTab, the Load statusLoad status  field is set to Open.

In the Load linesLoad lines  section, there is a single line where the QuantityQuantity  field is set to 10 and the WorkWork

created quantitycreated quantity  field is set to 0 (zero).

13. On the Action Pane, on the Ship and receiveShip and receive tab, select Confirm > Inbound shipmentConfirm > Inbound shipment. Notice that

the Load statusLoad status  has changed to Shipped.

14. Make a note of the Load IDLoad ID value, so that you can use it in the next procedure.

When the load arrives at the warehouse receiving dock, a receiving clerk registers the load quantities on a

mobile device.

1. Use your mobile device to sign in to warehouse 24. (In the standard demo data, sign in by using 24 as the

user ID and 1 as the password.)



Product receipt–post the registered load quantities against purchase ordersProduct receipt–post the registered load quantities against purchase orders

2. Select the Load item receiving menu item that you created for this scenario.

3. Follow the data entry instructions on the screen to enter the following values. (The order might vary,

depending on the mobile device or emulator that you're using.)

LoadLoad – Enter the load ID that you created in the previous procedure.

ItemItem – Enter A0001, which is the item that is expected for this load.

QtyQty  – Enter 9 as the actual quantity that is present on the load. Note that this quantity is less than the

expected quantity.

4. Continue to go through the workflow, leaving all other fields blank or set to their default values, until

your device informs you that the work is completed.

The load receiving task is now completed, and the receiving clerk can move on to his or her next task. However,

warehouse receiving personnel will eventually review the load record and will be able to see that the received

quantity was less than the expected quantity. They will then complete the following procedure by using the web

client.

1. Go to Warehouse management > Loads > All loadsWarehouse management > Loads > All loads .

2. In the list, find the load that you just received. (You might have to select the Show closedShow closed check box to

include the inbound loads that have a load status of Shipped.) Then select the link in the Load IDLoad ID column

to open the load.

3. In the load record, notice that the Load statusLoad status  value remains Shipped, but the Work created quantityWork created quantity

value on the load line has changed to 9.

4. Go to Procurement and sourcing > Purchase orders > All purchase ordersProcurement and sourcing > Purchase orders > All purchase orders .

5. In the list, find the purchase that you just received, and then select the link in the Purchase orderPurchase order

column to open the order. \

6. On the Purchase order linesPurchase order lines  FastTab, select Inventor y > View > TransactionsInventor y > View > Transactions .

7. Review the details of the two purchase order transactions. (You might have to personalize the Inventor yInventor y

transactionstransactions  page to see the Load IDLoad ID field to the grid.) You should see two transactions:

The transaction that has a receipt in Registered status represents the registration quantity of 9 that

was run against a specific load by using the mobile device. The Load IDLoad ID is associated with the

transaction in question.

The transaction that has a receipt in Ordered status represents the remaining unregistered order line

quantity of 1.

In this procedure, you will product receipt–post the inventory that you registered for a load. As a result, the

received inventory and its related costs will be added to the company's general ledger.

1. Go to Warehouse management > Loads > All loadsWarehouse management > Loads > All loads .

2. In the list, find the load that you received. (You might have to select the Show closedShow closed check box to

include the inbound loads that have a load status of Shipped.) Then select the link in the Load IDLoad ID column

to open the load.

3. On the Action Pane, on the Ship and receiveShip and receive tab, select Receive > Product receiptReceive > Product receipt. If you're

prompted to confirm the action, select YesYes .

4. In the Posting product receiptPosting product receipt dialog box, on the L inesLines  FastTab, inspect the grid. You should see the

purchase order line for which the quantity has been registered against the selected load.



Example scenario 2: Register quantities that arrive on multiple inbound loads where some items are missingExample scenario 2: Register quantities that arrive on multiple inbound loads where some items are missing

Set up load receiving policiesSet up load receiving policies

Create two loads to plan receipt of a purchase orderCreate two loads to plan receipt of a purchase order

NOTENOTE
In versions where the Multiple product receipt postings per load feature isn't available or isn't enabled, the default

quantity that is shown in the Load linesLoad lines grid will be the total quantity that has been registered across all loads

that are associated with the purchase order line.

5. On the Over viewOver view  FastTab, inspect the Product receiptProduct receipt field in the grid. Notice that it's to set to a

number that includes the ID of the selected load.

6. Select OKOK to post the product receipt and close the Posting product receiptPosting product receipt dialog box.

7. You're returned to the load details. Notice the following points:

The Load statusLoad status  field is now set to Received.

On the load line, the QuantityQuantity  value for the load has changed from 10 to 9 pcs to match the

registered quantity, but the Work created quantityWork created quantity  value remains 9.

If the purchasing team doesn't expect the vendor to deliver the remaining order quantity of 1, it can close the

order by updating the line's delivery remainder to 0. However, if it's soon found that the missing piece arrived on

the original load, warehouse personnel can perform one of the following actions:

Register the quantity against the same load. In this case, the Load statusLoad status  field will be reset to Shipped,

and the Work created quantityWork created quantity  value will be updated to 10. This choice is available only in the

following situations:

The Over receipt of load quantities feature isn't available or isn't enabled.

The Over receipt of load quantities feature is available and enabled, and the Load line quantity overLoad line quantity over

receiptreceipt field is set to Allow.

Add the quantity to a new or existing load, and process it in the usual way.

Register and/or receive the quantity in a way that doesn't involve load handling.

In this scenario, an inbound shipment that is related to a single purchase order line will be split into two loads.

For example, a purchase order line might be split into multiple loads because of physical load constraints on

weight and/or volume.

This scenario also shows how to process multiple product receipt postings for the same load. You will register

quantities that arrive on multiple inbound loads, but the quantities won't match the expected quantities. The cost

updates that occur via the product receipt posting will be done multiple times for the same load.

In this procedure, you will enable multiple product receipt postings from the same load.

1. Go to Warehouse management > Setup > Warehouse management parametersWarehouse management > Setup > Warehouse management parameters .

2. On the LoadsLoads  tab, set the Allow multiple product receipt per loadAllow multiple product receipt per load field to Yes.

In this procedure, you will create a purchase order and two loads. You will then manually update each load to

simulate that it has been shipped by the vendor (which updates the load status). Warehouse planners can then

filter loads by Load statusLoad status  to find expected incoming loads.

You will also learn how to set the purchase order line so that you can receive a quantity that is 20 percent more

than the quantity that is specified for the line.

1. Go to Procurement and sourcing > Purchase orders > All purchase ordersProcurement and sourcing > Purchase orders > All purchase orders .



Register partial receipt of the quantities that arrived on the first load and post the registered load quantitiesRegister partial receipt of the quantities that arrived on the first load and post the registered load quantities

2. Select NewNew .

3. On the VendorVendor  FastTab, set the Vendor accountVendor account field to 1001, and then select OKOK.

4. Your new purchase order is opened and includes a blank line in the Purchase order linesPurchase order lines  grid. Set the

following values for this order line:

Item number :Item number : A0001

Warehouse:Warehouse: 24

Quantity:Quantity: 10

5. On the L ine detailsL ine details  FastTab, on the Deliver yDeliver y  tab, set the Overdeliver yOverdeliver y  field to 20.

6. On the Action Pane, on the PurchasePurchase tab, select Actions > ConfirmActions > Confirm . The order status is now Confirmed.

7. On the Action Pane, on the WarehouseWarehouse tab, select Actions > Load planning workbenchActions > Load planning workbench.

8. On the Load planning workbenchLoad planning workbench page, on the Action Pane, on the Supply and demandSupply and demand tab, select

Add > To new loadAdd > To new load.

9. In the Load template assignmentLoad template assignment dialog box, set the Load template IDLoad template ID field to 20' Container. On the

DetailsDetails  tab, change the QuantityQuantity  value from 10 to 5 to partially add the purchase order line quantity.

10. Select OKOK to apply your settings and close the dialog box.

11. Repeat steps 8 through 10 to create a second load. This time, the QuantityQuantity  field should already be set to

5.

12. On the Load planning workbenchLoad planning workbench page, in the LoadsLoads  grid, select the Load IDLoad ID value for the first load

that you created. The Load detailsLoad details  page appears and shows the selected load. Follow these steps:

a. On the Action Pane, on the Ship and receiveShip and receive tab, select Confirm > Inbound shipmentConfirm > Inbound shipment.

b. Notice that the Load statusLoad status  value has changed to Shipped.

c. Select the close button to return to the Load planning workbenchLoad planning workbench page.

13. Repeat the previous step for the second load that you created.

14. Make a note of the two Load IDLoad ID values that appear in the LoadsLoads  grid.

When loads arrive at the warehouse receiving dock, a receiving clerk registers the load quantities on a mobile

device. The registered inventory that is linked to a load is then cost-updated in the company's general ledger by

posting the purchase order product receipt, based on the load.

This procedure shows how a receiving clerk will register load quantities on a mobile device.

1. Use your mobile device to sign in to warehouse 24. (In the standard demo data, sign in by using 24 as the

user ID and 1 as the password.)

2. Select the Load item receiving menu item that you created for this scenario.

3. Follow the data entry instructions on the screen to enter the following values. (The order might vary,

depending on the mobile device or emulator that you're using.)

LoadLoad – Enter the first load ID that you created in the previous procedure.

ItemItem – Enter A0001, which is the item that is expected for this load.

QtyQty  – Enter 3. Note that this quantity is less than the expected quantity. For this scenario, imagine that

you, as the receiving clerk, don't have time to register all quantities for this load. Later in this

procedure, you will register the remaining pieces by repeating this step and setting the QtyQty  field to 2.

4. Continue to go through the workflow, leaving all other fields blank or set to their default values, until

your device informs you that the work is completed.



Register receipt of the quantities that arrived on the second load and account for the overdelivered quantityRegister receipt of the quantities that arrived on the second load and account for the overdelivered quantity

NOTENOTE

5. In the web client, go to Warehouse management > Loads > All loadsWarehouse management > Loads > All loads .

6. In the list, find the load that you just received, and select the Load IDLoad ID value to open the load. Notice that

the Load statusLoad status  value remains Shipped, but the Work created quantityWork created quantity  value on the load line has

changed to 3.

7. On the Action Pane, on the Ship and receiveShip and receive tab, select Receive > Product receiptReceive > Product receipt. If you're

prompted to confirm the action, select YesYes .

8. In the Posting product receiptPosting product receipt dialog box, review but don't change the values that are shown, and then

select OKOK.

9. You're returned to the Load detailsLoad details  page for your selected load. Notice the following points:

The Load statusLoad status  field remains set to Shipped.

On the load line, the QuantityQuantity  value for the load remains 5 pcs, which is the original load quantity,

and the Work created quantityWork created quantity  value remains 3.

10. Complete the registration of the remaining quantity on this load by repeating this procedure. However, in

step 3, set the QtyQty  field to 2.

The receiving task for the first load is now completed. Two product receipt journals have been created, one for

each of the two product receipt updates that you ran.

For this scenario, the receiving clerk will inbound-register a quantity that exceeds the quantity that exists on the

load. Over-receiving will be permitted because the system is set up to allow overdelivery.

1. Use your mobile device to sign in to warehouse 24. (In the standard demo data, sign in by using 24 as the

user ID and 1 as the password.)

2. Select the Load item receiving menu item that you created for this scenario.

3. Follow the data entry instructions on the screen to enter the following values. (The order might vary,

depending on the mobile device or emulator that you're using.)

LoadLoad – Enter the second load ID that you created earlier.

ItemItem – Enter A0001, which is the item that is expected for this load.

QtyQty  – Enter 7, which is the remaining quantity that the vendor is authorized to deliver as part of total

purchase order quantity of 12 (where 10 is the original order quantity, and 2 is the allowed

overdelivery quantity of 20 percent). Remember that 5 pcs have already been registered against the

first load.

The second load has now been updated with the quantity of 7 and can be product receipt–updated based on this

quantity.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Create an item arrival journal header

This procedure shows you how to register items using the item arrival journal when you are using advanced

warehouse management processes. This would usually be done by a receiving clerk.

You can run this procedure in demo data company USMF, or on your own data. You need to have a confirmed

purchase order with an open purchase order line before you start this guide. The item on the line must be

stocked, and it must not use product variants, and must not have tracking dimensions. And the item needs to be

associated with a warehouse management process enabled storage dimension group. The warehouse that's

used must be enabled for warehouse management processes and the location that you use for receiving must

be license plate controlled. If you're using USMF, you can use company account 1001, Warehouse 51, and item

M9200 to create your PO.

Make a note of the number of the purchase order that you create, and also note the item number and the site

that you used for your purchase order line.

1. Go to Item arrival.

2. Click New.

3. In the Name field, type a value.

4. In the Number field, type a value.

5. In the Site field, type a value.

6. In the Warehouse field, type a value.

7. In the Location field, type a value.

8. Right-click on the drop-down arrow in the License plate field and then select View details.

9. Click New.

10. In the License plate field, type a value.

11. Click Save.

12. Close the page.

13. In the License plate field, type a value.

If you are using USMF, you can type WHS. If you're using other data, the journal whose name you

choose has to have the following properties: Check picking location must be set to No, and

Quarantine management must be set to No.

Select the site that you used for your purchase order line. This will serve as a default value, which will

default to all lines in the journal. If you used warehouse 51 in USMF, choose site 5.

Select a valid warehouse for the site that you've selected. This will serve as a default value, which will

default to all lines in the journal. If you're using the example values in USMF, select 51.

Select a valid location in the warehouse that you've selected. The location has to be associated with a

location profile, which is license plate controlled. This will serve as a default value, which will default to

all lines in the journal. If you're using the example values in USMF, select Bulk-008.

Make a note of the value.

Enter the value of the license plate that you just created. This will serve as a default value, which will

default to all lines in the journal.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/tasks/register-items-advanced-warehousing.md


Add a line

Complete the registration

NOTENOTE

14. Click OK.

1. Click Add line.

2. In the Item number field, type a value.

3. In the Quantity field, enter a number.

Enter the item number that you used on the purchase order line.

Enter the quantity that you want to register.

The Date field determines the date on which the on-hand quantity of this item will be registered in the

inventory.

The lot ID will be populated by the system if it can be uniquely identified from the information

provided. Otherwise you will have to add this manually. This is a mandatory field, which links this

registration to a specific source document line.

1. Click Validate.

2. Click OK.

3. Click Post.

4. Click OK.

5. Close the page.

This checks that the journal is ready to be posted. If the validation fails you will need to fix the errors

before you can post the journal.

After you clicked OK, check the message. There should be a message saying that the journal is OK.

After you have clicked OK, check the message bar. There should be a message saying that the

operation completed.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Create item arrival journal header

Add lines to item arrival journal

Post the journal

Generate the product receipt

This procedure shows you how to register items using the item arrival journal when you are using "basic

warehousing" in the Inventory management module. This would usually be done by a receiving clerk. You can

run this procedure in demo data company USMF with the example values that are shown. If you are not using

USMF, you need to have a confirmed purchase order with an open purchase order line before you start this

guide. The item on the line must be stocked. And the item needs to be associated with a storage dimension

group, where site and warehouse are active.

1. Go to Inventory management > Journal entries > Item arrival > Item arrival.

2. Click New.

3. In the Name field, type a value.

4. In the Packing slip field, type a value.

5. In the Number field, In the Number field, select the purchase order..

6. Click OK.

If you are using USMF, you can type WHS. If you're using other data, the journal whose name you

choose has to have the following properties: cheque picking location must be set to No, and

Quarantine management must be set to No.

This is the packing slip ID from the packing slip issued by the vendor. Add a unique number.

1. Click Functions.

2. Click Create lines.

3. Check or uncheck the Initialize quantity checkbox.

4. Click OK.

The lines can be entered manually into this journal or created automatically. This will show you how to

create this automatically.

This will initialize the quantity on the journal lines with the quantity not registered from the purchase

order line.

1. Click Post.

2. Click OK.

1. Click Functions.

2. Click Product receipt.

3. Click OK.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/tasks/register-items-basic-warehousing.md
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stores
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NOTENOTE

This procedure walks through the steps to create and process a Cross-dock to distribute products from the

receiving location of a purchase order to one or many stores. The user can define multiple configurations and

have the system suggest how to distribute the products, or manually enter where the products are distributed to

and how much gets distributed to each store. The procedure doesn't include setup of data that can be used in

the Cross-dock, such as replenishment rules, organizational hierarchies, and store weights. The procedure uses

the USRT demo company.

1. Go to All purchase orders.

2. Select a purchase order in the list and click the link to open the order.

3. On the Action Pane, click Retail and Commerce.

4. Click Cross docking.

5. Click Edit.

6. In the list, find and select the desired record.

7. In the Cross docking quantity field, type a value to specify how much of the quantity being purchased of the

selected product should be distributed.

8. In the Additional cross docking quantity field, enter a value to specify the quantities to distribute for the

available products being purchased

9. In the Distribution field, enter 'Location weight'.

10. In the Replenishment hierarchy field, select a value.

11. Select Yes in the Respect assortments field.

12. Click Calculate quantities.

13. Click Create order.

14. Click Yes.

15. In the list, find and select a warehouse that received products

16. Click Order to view the orders that got created for the selected warehouse

The category can be used to filter the items in the Lines section.

You can select the other types to use different rules for the distribution.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/tasks/cross-dock-products-receiving-warehouse-stores.md
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Create a location directive header

Edit the query for directive

Add directive lines

This topic explains how to set up a simple location directive. The example that's shown creates a location

directive to be used to determine where to put items that have been received for a purchase order. You can play

this task guide with the data mentioned using demo data company USMF. Pre-conditions: You need to create a

disposition code. In this procedure we use a disposition code called Relabel. If you're creating a location directive

in your own data, you need to have set up advanced warehouse management for your warehouse and items.

This procedure is intended for the warehouse manager.

1. In the navigation pane, go to Modules > Warehouse management > Setup > Location directivesModules > Warehouse management > Setup > Location directives .

2. In the Work order typeWork order type field, select Purchase ordersPurchase orders .

1. Select NewNew .

2. In the Sequence numberSequence number  field, enter a number. This is the sequence in which the location directive is

processed for the selected work type. You can also modify the sequence, if needed.

3. In the NameName field, type a value. This is the unique identifier for this directive.

4. In the Work typeWork type field, select PutPut. Select the type of work to be performed. For directive with work order

type Purchase order, PutPut is the only supported value.

5. In the S iteSite field, type a value.

6. In the WarehouseWarehouse field, type a value. Leave the Directive code blank. Directive codes are used to link a work

order line of type Put to a specific directive. For purchase orders, the location of the last work order line of

type Put is resolved before the work template is determined. Therefore it is not possible to connect the last

line of a work template to a specific directive.

7. In the Disposition codeDisposition code field, type a value. The Disposition code limits the use of the location directive, so

the location directive is only used if the warehouse worker enters this specific value during registration of the

item using a mobile device.

8. Select SaveSave.

1. Select Edit quer yEdit quer y . The use of this directive is already limited to be used for items registered in the

warehouse that you specified, and with the disposition code that you specified. You can add other constraints

using the query.

2. Select OKOK.

1. Select NewNew . This is the sequence in which the location directive lines are processed for the selected work

type. You can also modify the sequence, if needed.

2. In the From quantityFrom quantity  field, enter a number. This is the lowest quantity that this directive line is valid for.

3. In the To quantityTo quantity  field, enter a number.

4. In the UnitUnit field, type a value. The unit the From quantity and To quantity is expressed in. If you leave this

field blank the inventory unit from the item is used.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/transportation/tasks/set-up-location-directive-purchase-order-put-away.md


Restrict the directive line to a specific unit

Add a location directive action line

Edit the query for directive action line

5. In the Locate quantityLocate quantity  field, select an option.

6. Check or uncheck the Restr ict by unitRestr ict by unit checkbox. If you select this option, and specify the unit on the

Restr ict by unitRestr ict by unit page, only items with that unit of measurement can be put into the location. For example, if

the unit of measurement is PL (pallets), only items in pallets can be put into the specified location.

7. Check or uncheck the Allow splitAllow split checkbox. This allows the directive to split the quantity across multiple

locations.

8. Select SaveSave.

None, or license plate quantity: The quantity registered on each license plate.

Unitized quantity: The entire quantity that's been registered.

Remaining quantity: The quantity that is yet to be registered from the purchase order line.

Expected quantity: The total quantity that is specified on the purchase order line.

1. Select Restr ict by unitRestr ict by unit. This button is only available when you press SaveSave after you have selected the

Restr ict by unitRestr ict by unit check box.

2. In the UnitUnit field, type a value.

3. Close the page.

1. Select NewNew . This is the sequence in which the location directive action lines are processed for the selected

work type. You can also modify the sequence, if needed.

2. In the NameName field, type a value. This is the unique identifier for this directive action.

3. In the Fixed location usageFixed location usage field, select an option.

4. In the StrategyStrategy  field, select an option. Work orders of type Purchase order support the following strategies:

5. Select SaveSave.

Fixed and non-fixed locations: All non-fixed locations are valid as well as the product's own fixed

location, within the range specified in the query.

Only fixed location for the product: Fixed locations for the product are valid, and all product variants

share the same set of fixed locations.

Only fixed location for the product variants: Only fixed locations specified for each product variant are

valid.

None: the item is placed at the first location that's found.

Consolidate: The item is placed in a location where similar items are already available.

Empty location with no incoming work: the item is placed in the first empty location that's found. A

location is considered to be empty if it has no physical inventory and no expected incoming work.

1. Select Edit quer yEdit quer y .

2. Select AddAdd.

3. In the FieldField field, type location profile ID . In this example, we'll restrict the possible locations using a

location profile ID.

4. In the Criter iaCriter ia field, type a value.

5. Select OKOK. You can continue to add directive lines and directive actions until you have covered all the possible

scenarios in your warehouse.
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Create a work template header

Set up the query for the work template

Set work template details

This topic describes how to set up a simple work template to be used when putting away received items. Work

templates determine the set of instructions presented to the warehouse worker on a mobile device when

moving items from the receiving area. You can use this procedure with the data mentioned in demo data

company USMF. Before you start this guide, create a work pool ID. In this example, a work pool ID called in

Inbound is used. This procedure is intended for the warehouse manager.

1. In the navigation pane, go to Modules > Warehouse management > Setup > Work > WorkModules > Warehouse management > Setup > Work > Work

templatestemplates .

2. In the Work order typeWork order type field, select Purchase ordersPurchase orders .

1. Select NewNew .

2. In the Sequence numberSequence number  field, enter a number. This is the sequence in which the work templates are

evaluated. You can modify the sequence, if needed.

3. In the Work templateWork template field, type a value. This is the unique identifier for this template.

4. In the Work template descr iptionWork template descr iption field, type a value.

5. In the Work pool IDWork pool ID field, type a value. Work pool IDs allow you to organize work into groups. The value

that you set here will be the default value for any work that's created using this template.

6. In the Work pr ior ityWork pr ior ity  field, enter 1 . This indicates the importance of the work, and the value that you set

here will be the default for any work created using this template.

7. Select SaveSave. You must save the work template header before the Edit Quer yEdit Quer y  button becomes available.

The ValidValid option will not be checked until you've completed all the information that's needed by the

template and have then selected SaveSave.

A work order of type Purchase orderPurchase order  cannot be automatically processed, so leave the

Automatically processAutomatically process  option set to NoNo.

1. Select Edit quer yEdit quer y . We'll set a limitation that the template can only be used within a specific warehouse.

2. Select AddAdd.

3. In the FieldField field of the new row, type warehouse .

4. In the Criter iaCriter ia field, type a value.

5. Select OKOK.

6. Select YesYes .

1. Select NewNew .

2. In the Work typeWork type field, select PickPick .

3. In the Work class IDWork class ID field, type purchase . The work class that you set here will be the default on all work

lines of type Pick that are created using this template. The work class cannot be overridden from the work

order lines. Work classes are used to direct and/or limit the type of work order lines a warehouse worker can

process on a mobile device.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/tasks/set-up-work-template-purchase-orders.md


NOTENOTE

4. Select NewNew .

5. In the Work typeWork type field, select PutPut.

6. In the Work class IDWork class ID field, type a value. The pick and put instructions are a set. Each pick/put set must have

the same work class. Use the same work class that you provided for the pick instruction.

7. Select SaveSave. Note that the ValidValid checkbox is now checked.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Turn on the Location product dimension mixing feature

Setup

Configure location profiles to allow product dimension mixingConfigure location profiles to allow product dimension mixing

Create a new product master and product variantsCreate a new product master and product variants

Location product dimension mixing is location profile functionality that helps improve location management

when product variants or products that have dimensions are used, such as in the fashion industry. It lets you

decide whether configurations, colors, styles, and sizes can be mixed for a specific location profile, or whether

just one of these dimensions or a combination of them can be put to the same location.

Before you can use location product dimension mixing, the feature must be turned on in your system. Admins

can use the Feature management workspace to check the status of the feature and turn it on if it's required.

There, the feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Location product dimension mixing

Every location in the warehouse needs to have a location profile associated with it that describes the properties

of the location. Therefore, all locations that use the same location profile will be able to allow product dimension

mixing after it has been set up.

NOTENOTE

1. Go to Warehouse management > Setup > Warehouse > Location profilesWarehouse management > Setup > Warehouse > Location profiles .

2. In the list of location profiles, select BULKBULK.

3. On the Action Pane, select EditEdit.

4. On the GeneralGeneral  FastTab, set the Enable location product dimension specific mixingEnable location product dimension specific mixing option to Yes.

You can set this option to Yes only if the Allow mixed itemsAllow mixed items option is set to No.

5. On the Allowed product dimension mixingAllowed product dimension mixing FastTab, set the S izeSize option to Yes. In the scenario that is

described in this topic, mixing can be done only for products that have different S izeSize dimensions.

However, other options are also available.

6. Select SaveSave.

1. Go to Product information management > Products > Product mastersProduct information management > Products > Product masters .

2. On the Action Pane, select NewNew  to create a product master.

3. In the New productNew product dialog box, set the following values:

Product type:Product type: Item

Product subtype:Product subtype: Product master

Product number :Product number : B0001

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/location-product-dimension-mixing.md


Release products to the USMF companyRelease products to the USMF company

Update a released product in the USMF companyUpdate a released product in the USMF company

Product name:Product name: B0001 Size

Product dimension group:Product dimension group: Size

Configuration technology:Configuration technology: Predefined variant

4. Select OKOK.

5. On the Product detailsProduct details  page, on the GeneralGeneral  FastTab, set the following values:

Generate var iants automatically:Generate var iants automatically: Yes

Size group:S ize group: CASUALDHIR

6. To view the predefined variants, on the Action Pane, select Product var iantsProduct var iants .

The Product var iantsProduct var iants  page appears and shows a list of variants from the configuration of the size

group.

1. On the Action Pane, select Release productsRelease products .

2. On the Select products to releaseSelect products to release page, confirm that product number B0001 is in the list, and then

select NextNext.

3. Select NextNext to confirm the product variants to release.

4. On the Select companies to release toSelect companies to release to page, select USMF, and then select NextNext to confirm the

selection.

5. On the Confirm selectionConfirm selection page, select FinishFinish to complete the release.

You receive an "Operation completed" message.

1. Make sure that you're signed in to the USMFUSMF company.

2. Go to Product information management > Products > Released productsProduct information management > Products > Released products  to finish creating the

released product.

3. Find and select item number B0001 to open the Released product detailsReleased product details  page.

4. On the Action Pane, select EditEdit.

5. On the GeneralGeneral  FastTab, make sure that the Item model groupItem model group field is set to FIFO.

6. On the Action Pane, on the ProductProduct tab, in the Set upSet up group, select Dimension groupsDimension groups .

7. Set the following values:

Storage dimension group:Storage dimension group: Ware

Tracking dimension group:Tracking dimension group: None

8. Select OKOK.

9. On the Action Pane, on the ProductProduct tab, in the Set upSet up group, select Reser vation hierarchyReser vation hierarchy .

10. Set the Reser vation hierarchyReser vation hierarchy  field to Default, and then select OKOK.

11. On the GeneralGeneral  FastTab, in the AdministrationAdministration section, notice that your selections have been updated.

12. On the PurchasePurchase FastTab, in the Pr icePrice field, enter 10.

13. On the Manage costsManage costs  FastTab, in the Item groupItem group field, enter Audio.

14. On the PurchasePurchase FastTab, in the Pr icePrice field, enter 10.



Create a location directiveCreate a location directive

NOTENOTE

Create a mobile device menu itemCreate a mobile device menu item

15. On the WarehouseWarehouse FastTab, in the Unit sequence group IDUnit sequence group ID field, enter ea.

16. Select SaveSave.

1. Go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives .

2. In the left pane, in the Work order typeWork order type field, select Purchase orders.

3. In the list, select the location directive that is named 24 PO Direct.

4. On the Location Directive ActionsLocation Directive Actions  FastTab, select NewNew  to add a line to the grid.

5. On the new line, set the following values:

Sequence number :Sequence number : 1

The new line should be in front of the previously existing line. To make the change, use the MoveMove

upup and Move downMove down buttons on the toolbar, or change the existing line's Sequence numberSequence number

value to 2.

Name:Name: Put to BULK Location profile

Fixed location usage:Fixed location usage: Fixed and non-fixed locations

Allow negative inventor y:Allow negative inventor y: Clear this check box (=No)

Batch enabled:Batch enabled: Clear this check box (=No)

Strategy:Strategy: None

6. While the new line is still selected, select Edit quer yEdit quer y  above the grid.

7. In the query dialog box, on the RangeRange tab, select AddAdd to add a line to the grid.

8. On the new line, set the following values:

Table:Table: Locations

Derived table:Derived table: Locations

Field:Field: Location profile ID

Criter ia:Cr iter ia: BULK

9. Select OKOK.

10. On the Location directivesLocation directives  page, on the Action Pane, select SaveSave.

On the Location Directive ActionsLocation Directive Actions FastTab StrategyStrategy field, if you use the Consolidate location strategy, the setup of

the Allowed product dimension mixingAllowed product dimension mixing FastTab on the Location profilesLocation profiles  will be overridden, and items will be put to

the same location even if this behavior isn't allowed by the setup.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. On the Action Pane, select NewNew  to create a menu item to use for sorting.

3. In the header, set the following values:

Menu item name:Menu item name: PO line receiving

Title:Title: PO line receiving



Configure the mobile device menuConfigure the mobile device menu

Scenario

Create a purchase orderCreate a purchase order

Mode:Mode: Work

Use existing work :Use existing work : No

4. On the GeneralGeneral  FastTab, set the following values:

Work creation process:Work creation process: Purchase order line receiving and putaway

Generate license plate:Generate license plate: Yes

5. Select SaveSave.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menuWarehouse management > Setup > Mobile device > Mobile device menu.

2. In the list of menus, select InboundInbound.

3. On the Action Pane, select EditEdit.

4. In the Available Menus And Menu ItemsAvailable Menus And Menu Items list, find and select the PO line receivingPO line receiving menu item.

5. Select the right arrow button to move the PO line receivingPO line receiving menu item to the Menu StructureMenu Structure list. In this

way, you add your new menu item to the selected menu.

6. Select SaveSave.

This demo scenario shows how two different product variants can be put to the same location when the location

profile doesn't allow for mixed items, but the Location product dimension mixing feature is enabled. In this case,

you will use the S izeSize variant as the criterion.

Before you begin, make sure that there are empty locations in warehouse 24 that use the BULK location profile.

You will create a purchase order that has three lines: two lines for the same product number but different S izeSize

variants, and a third line for a different product that has no variants.

1. Go to Accounts payable > Purchase orders > All purchase ordersAccounts payable > Purchase orders > All purchase orders .

2. On the Action Pane, select NewNew .

3. In the Create purchase orderCreate purchase order  dialog box, set the following values:

Vendor account:Vendor account: 1001

Warehouse:Warehouse: 24

4. Select OKOK.

5. The purchase order is created, and a new line is added on the Purchase order linesPurchase order lines  FastTab. Make a

note of the purchase order number.

6. On the new line, set the following values:

Item number :Item number : B0001

SizeSize L

Quantity:Quantity: 2

7. Select Add lineAdd line above the grid to add a second purchase order line, and set the following values:

Item number :Item number : B0001

SizeSize XL

Quantity:Quantity: 2

8. Select Add lineAdd line to add a third purchase order line, and set the following values:

Item number :Item number : A0001



Receive purchase order lines in the warehouse appReceive purchase order lines in the warehouse app

Quantity:Quantity: 1

1.Select SaveSave.

1. Sign in to the warehouse app as a user who is enabled for warehouse 24.

2. Select the InboundInbound menu.

3. Select PO Line receivingPO Line receiving.

4. Select the PONUMPONUM field, and then enter the purchase order number.

5. Confirm your entry by selecting the confirm button ( ✔ ) at the bottom of the page.

6. Enter the line number from the purchase order that is being received. Select the L INENUMLINENUM field, and

then use the number pad to enter 1.

7. Confirm your entry.

8. Enter the quantity to receive. Select the plus sign (++) button two times to increase the value in the QtyQty

field to 2.

9. Register your entry by selecting the button ( ✔ ) at the bottom of the page, and then confirm your entry

by selecting the button ( ✔ ) again.

10. View the information on the Purchase orders: PutPurchase orders: Put page. This page shows the work that has been

created for the put-away (Work 1).

The location where the received item will be put away, the license plate, the item, the size, and the

quantity of the PO Line receivingPO Line receiving task that you just completed are shown.

11. Confirm the put-away work.

12. Repeat the steps 4 through 11 for the purchase order line 2. However, in step 8, specify a quantity of 1.

New put-away work (Work 2) is created for the same location as Work 1.

13. Repeat the steps 4 through 11 again for purchase order line 2. In step 8, specify the remaining quantity of

1.

New put-away work (Work 3) is created for the same location as Work 1 and Work 2. This behavior

occurs because the Consolidate location directive strategy is used, and the Allowed productAllowed product

dimension mixingdimension mixing FastTab on the Bulk Location profilesLocation profiles  setup allows the S izeSize variant to be mixed on

a location.

14. Repeat the steps 4 through 11 for purchase order line 3. In step 8, specify a quantity of 1 for item number

A0001.

New put-away work (Work 4) is created for a different location than the location that is used for purchase

order lines 1 and 2. This behavior occurs because the location profile doesn't allow for mixed products,

but it does allow for mixed dimensions of the same product master.

15. Select the Menu button at the top of the page (sometimes referred to as the hamburger or the

hamburger button), and then select CancelCancel  to exit PO Line receivingPO Line receiving.



TIPTIP

NOTENOTE

You can repeat this scenario, but this time, set SizeSize - No under the Allow product dimension mixingAllow product dimension mixing FastTab on the

BULK Location profilesLocation profiles , so that none of the product dimensions can be mixed. In this case, when you receive the

purchase order, each product variant will be put to a new location.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Turn on the cluster putaway feature

Setup for the example scenario
Cluster profilesCluster profiles

Putaway clusters offer a way to pick multiple license plates at the same time and then take them for putaway in

different locations. This process is often referred to as a milk run. Putaway clusters can be very useful for retail

businesses, where license plates typically aren't full pallets of inventory.

Before you can use this feature, it must be turned on in your system. Admins can use the Feature management

workspace to check the status of the feature and turn it on if it's required. There, the feature is listed in the

following way:

Module:Module: Warehouse management

Feature name:Feature name: Cluster putaway feature

The putaway cluster profile determines where an item will go, based on the location that is assigned to the item

at the time of receipt. If different clusters are required, different putaway clusters should be created, one for each

mobile device menu item.

1. Go to Warehouse management > Setup > Mobile device > Cluster profilesWarehouse management > Setup > Mobile device > Cluster profiles .

2. On the Action Pane, select NewNew .

3. In the HeaderHeader  view, set the following values:

Putaway cluster profile ID:Putaway cluster profile ID: Cluster putaway

Putaway cluster profile ID Name:Putaway cluster profile ID Name: Cluster putaway

Cluster type:Cluster type: Putaway

Sequence number :Sequence number : Accept the default value.

4. Select SaveSave to make the required fields on the GeneralGeneral  FastTab available.

5. On the GeneralGeneral  FastTab, set the following values:

Cluster assignment timing:Cluster assignment timing: At receipt

This field defines whether the putaway cluster should be assigned immediately when the

inventory is received, or whether it should be sorted later.

Cluster assignment rule:Cluster assignment rule: Manual

This field defines whether the cluster assignment should be determined automatically by the

system or manually by the user.

Directive code:Directive code: Leave this field blank.

Putaway cluster locate:Putaway cluster locate: Receipt

The following values are available:

ReceiptReceipt – A location is found immediately during receipt.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/putaway-clusters.md
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Work Work Warehouse 61

Work Work Work ID Leave this field blank.

Cluster closeCluster close – A location is found when the cluster is closed.

User directedUser directed – A location is found when the license plate is picked from the cluster for

putaway. In this case, no location is specified when the putaway work is created. During the

putaway itself, the user must scan the license plate or work ID to initiate the put step. The

system then finds the put location again and tells the user where to put the picked quantity.

Putaway cluster per user :Putaway cluster per user : No

This field defines whether each cluster should be unique per user when clusters are automatically

assigned. It's available only when the Cluster assignment ruleCluster assignment rule field is set to Automatic.

Unit restr iction:Unit restr iction: Leave this field blank.

This field defines the unit that must be received for the profile to be valid. If it's left blank, all units

are valid.

Work unit break :Work unit break : Individual

This field defines whether all inventory should be consolidated (by using the cluster ID and the

license plate) onto one license plate when a cluster is closed, and whether it should be put away as

a single license plate or separately on the license plates that were received. This field is unavailable

when the Putaway cluster locatePutaway cluster locate field is set to Receipt.

Cluster persists as Parent L icense Plate:Cluster persists as Parent L icense Plate: No

If this option is set to Yes, when the put step is completed, the cluster ID will become a parent

license plate, and all items on the cluster ID will be linked to that parent license plate.

6. On the Cluster sor tingCluster sor ting FastTab, you can define putaway sorting criteria. Select NewNew  on the toolbar to

add a line, and then set the following values:

Sequence number :Sequence number : Accept the default value.

Field name:Field name: WMSLocationId

This field defines the field that this line should use as a sorting criterion.

Sor ting:Sor ting: Ascending

This field defines whether sorting should be done in ascending or descending order.

7. On the Cluster work templateCluster work template FastTab, select NewNew  on the toolbar to add a line, and then set the

following values:

Work order type:Work order type: Purchase orders

Work template:Work template: 61 PO Direct

8. On the Action Pane, select SaveSave, and then select Edit quer yEdit quer y .

9. In the Cluster putawayCluster putaway  dialog box, on the RangeRange tab, select AddAdd to add a second line to the query. Then

update the query lines as shown in the following table.

10. Select OKOK to save the query and close the dialog box.

11. On the Action Pane, select SaveSave, and close the page.



IMPORTANTIMPORTANT

Mobile device menu itemsMobile device menu items

Receive and sort clusterReceive and sort cluster

NOTENOTE

Cluster putawayCluster putaway

Fields in the cluster profile that appear dimmed when Generate cluster IDGenerate cluster ID is set to Yes are unavailable and won't be

considered when this feature is used.

Two new mobile device menu items are available for this feature. The Receive and sor t clusterReceive and sor t cluster  menu item is

used to sort the received inventory into a putaway cluster upon receipt. The Cluster putawayCluster putaway  menu item is

used to put the cluster away after it has been assigned.

Create a new mobile device menu item for receiving inventory and sorting into a cluster. This menu item will

create inbound work after inventory is received, which indicates that the receiving menu item will be used for

putaway clusters.

The Receive and sor t clusterReceive and sor t cluster  menu item can be used with the following receiving menu items:

Purchase order line receiving

Purchase order item receiving

Load item receiving

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. On the Action Pane, select NewNew .

3. In the HeaderHeader  view, set the following values:

Menu item name:Menu item name: Receive and sort cluster

Title:Title: Receive and sort cluster

Mode:Mode: Work

Use existing work :Use existing work : No

4. On the GeneralGeneral  FastTab, set the following values:

NOTENOTE

Work creation process:Work creation process: Purchase order item receiving

Generate license plate:Generate license plate: Yes

Assign putaway cluster :Assign putaway cluster : Yes

The Assign putaway clusterAssign putaway cluster  option is available only for the one-step Work creation process activity for

receiving.

Accept the default values for the remaining fields.

5. On the Action Pane, select SaveSave.

Create a new mobile device menu item for putting the cluster away after it has been assigned.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. On the Action Pane, select NewNew .



Mobile device menuMobile device menu

Example scenario

Create a purchase orderCreate a purchase order

3. In the HeaderHeader  view, set the following values:

Menu item name:Menu item name: Cluster putaway

Title:Title: Cluster putaway

Mode:Mode: Work

Use existing work :Use existing work : Yes

4. On the GeneralGeneral  FastTab, set the Directed byDirected by  field to Cluster putaway. Accept the default values for the

remaining fields.

5. On the Work classesWork classes  FastTab, set up the valid work class for this mobile device menu item:

Work class ID:Work class ID: Purchase

Work order type:Work order type: Purchase orders

6. On the Action Pane, select SaveSave.

Add the menu items that you just created to the inbound menu of the mobile app.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menuWarehouse management > Setup > Mobile device > Mobile device menu.

2. On the Action Pane, select EditEdit.

3. In the menu list, select InboundInbound.

4. In the Available menus and menu itemsAvailable menus and menu items list, find and select Receive and sor t clusterReceive and sor t cluster .

5. Select the right arrow button to move the selected menu item to the Menu structureMenu structure list.

6. Use the up arrow or down arrow button to move the menu item into the desired position in the menu.

7. On the Action Pane, select SaveSave.

8. Repeat steps 4 through 7 to add the remaining menu items:

Assign cluster

Cluster putaway

This scenario simulates putaway cluster processing.

1. Go to Accounts payable > Purchase orders > All purchase ordersAccounts payable > Purchase orders > All purchase orders .

2. On the Action Pane, select NewNew .

3. In the Create purchase orderCreate purchase order  dialog box, set the following values:

Vendor account:Vendor account: 1001

Warehouse:Warehouse: 61

4. Select OKOK.

The All purchase ordersAll purchase orders  page appears.

5. On the All purchase ordersAll purchase orders  page, on the Purchase order linesPurchase order lines  FastTab, use the Add lineAdd line button to

add the following lines:

Purchase order line 1:

Item number :Item number : A0001



Receive inventory and put it away from the mobile deviceReceive inventory and put it away from the mobile device
Receive and sort the inventory into a clusterReceive and sort the inventory into a cluster

Close the clusterClose the cluster

Quantity:Quantity: 10

Purchase order line 2:

Item number :Item number : A0002

Quantity:Quantity: 20

Purchase order line 3:

Item number :Item number : M9215

Quantity:Quantity: 30

6. On the Action Pane, select SaveSave.

7. Make a note of the purchase order number.

1. Sign in to the warehouse app as a user who is set up for warehouse 61.

2. On the main menu, select InboundInbound.

3. On the InboundInbound menu, select Receive and sor t clusterReceive and sor t cluster .

4. In the PonumPonum field, enter the purchase order number.

5. Select OKOK (the check mark button).

6. Select the ItemItem field, enter item number A0001, and then select OKOK.

7. Select the QtyQty  field, enter 10 by using the number pad, and then select the check mark button.

8. On the QtyQty  task page, select OKOK (the check mark button) to confirm the quantity that you entered.

9. On the ItemItem task page, select OKOK to confirm that item A0001 was entered.

10. Select the Cluster IDCluster ID field, and enter a value to assign an ID for the cluster that you're creating.

The ID that you enter here will be used when the two remaining items on the purchase order are

received.

11. Select OKOK.

The PonumPonum task page appears and shows a "Work completed" message.

Item A0001 has now been received into the RECV location and assigned to the cluster ID that you entered

in step 10.

12. Repeat steps 4 through 11 to receive the remaining two items from the purchase order and assign them

to the cluster ID:

A quantity of 20 for item A0002

A quantity of 30 for item M9215

Before the items in the cluster can be put away, the cluster must be closed.

1. In Supply Chain Management, go to Warehouse management > Work > Outbound > WorkWarehouse management > Work > Outbound > Work

clustersclusters .

2. On the Work clustersWork clusters  page, in the Work clusterWork cluster  section, search the Cluster IDCluster ID field for the cluster ID

that you entered earlier.

3. If the cluster isn't shown, it might already have been closed. To determine whether the cluster was closed,



  Put the cluster awayPut the cluster away

Notes and tips

select the Show closed workShow closed work check box, and search for the cluster ID that you entered earlier. Then

follow one of these steps:

If the cluster has been closed, skip the remaining steps of this procedure, and move on to the next

procedure, Put the cluster away.

If the cluster hasn't been closed, follow the remaining steps of this procedure to manually close the

cluster. Then move on to the next procedure.

4. In the Work clusterWork cluster  section, select the cluster ID that you entered earlier.

5. On the Action Pane, select Close clusterClose cluster .

After the cluster has been closed, it's no longer shown in the Work clusterWork cluster  section (unless the ShowShow

closed workclosed work check box is selected).

1. Sign in to the warehouse app as a user who is set up for warehouse 61.

2. On the main menu, select InboundInbound.

3. On the InboundInbound menu, select Cluster putawayCluster putaway .

4. Select Cluster IDCluster ID, and enter the cluster ID that you entered earlier for the closed cluster.

5. Select OKOK.

The Cluster putaway: PickCluster putaway: Pick  page appears. It shows the cluster ID, the picking location, the items (the

value Multiple will be shown), and the total quantity in the cluster that must be picked.

6. Select OKOK.

The Cluster putaway: PutCluster putaway: Put page appears. The PutPut instructions identify the cluster ID, the put location,

the items, the total quantity, and the license plate IDs for the items that have been received on the cluster.

You have the standard options to override or pass this step.

7. Select OKOK to confirm the putaway of the cluster.

A "Cluster completed" message is shown.

For cases where the cluster ID becomes the parent license plate for a nested pallet, the put position is

automatically given when the cluster ID is scanned. No further license plate must be scanned, even if license



NOTENOTE

plate generation is set to manual.
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Turn on the Quality check feature

Set up the feature for the example scenario

Make sample data availableMake sample data available

Quality check templateQuality check template

The Quality check feature lets warehouse workers do quick spot checks for quality while they receive items to

the inbound dock area. These spot checks are beneficial when workers inspect packaging or other easily

recognizable parts of an item. The feature guides workers to take a quick look to see whether anything is

obviously faulty or damaged before they stock the inventory in its putaway location.

This feature is an alternative to the standard quality check process. It offers more flexibility and faster

processing.

When you use this feature, the arrival and quality check occur in the following way:

1. When a shipment arrives, a warehouse worker registers the arrival. The worker also scans a license plate

to register the location.

2. The worker does a quick quality check and records the result (pass or fail) for that license plate.

3. One of the following actions occurs:

If the quality check is passed, the license plate is accepted and guided to a receiving location, as usual.

If the quality check is failed, the license plate is rejected, and existing putaway work for it is redirected

to an alternate location for further inspection. A new quality order is created. To view the quality order

that is created from the failed quality check, go to Inventor y management > Periodic tasks >Inventor y management > Periodic tasks >

Quality management > Quality ordersQuality management > Quality orders .

This process can also be set up so that all scanned license plates are immediately diverted to the quality check

location.

Before you can use the Quality check feature, it must be turned on in your system. Admins can use the feature

management settings to check the status of the feature and turn it on if it's required. In the FeatureFeature

managementmanagement workspace, the feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Quality check

This section provides guidelines and an example that shows how to set up the Quality check feature and prepare

sample data for the example scenario that is provided later in this topic.

To work through the example scenario by using the sample records and values that are specified here, you must

be on a system where the standard demo data is installed. Additionally, you must select the USMFUSMF legal entity

before you begin.

The quality check template defines the rules for doing quick spot checks for quality at the time of receiving.

1. Go to Warehouse management > Setup > Work > Quality check templateWarehouse management > Setup > Work > Quality check template.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/quality-check.md


      Work class – Quality checkWork class – Quality check

2. Select NewNew  to add a template to the grid.

3. Set the following values to define the new template:

Quality check template name:Quality check template name: Dock check

Enter a name that identifies the policies applied for this template.

Acceptance policy:Acceptance policy: Prompt user

Specify whether users should be prompted to accept or reject the quality of the inventory while

they process the work, or whether the quality should automatically be rejected. The available

options are Auto reject and Prompt user.

Quality processing policy:Quality processing policy: Create quality order

Select the policy that should be used when the quality of the inventory is rejected. The following

options are available:

Create work only – Just create work to facilitate inventory movement.

Create quality order – Create a quality order to facilitate quality tests.

Test group:Test group: Enclosure

Specify the test group that should be used in the quality order that is created. Test groups are set

up in the Inventor y managementInventor y management module.

Leave the Destructive textDestructive text option turned off for the test group. This option defines whether the

sample will be destroyed as part of the tests in the test group. If a destructive test is used, the

system generates an inventory transaction when a quality order is created for an item. The new

inventory transaction predicts the inventory reduction for the test quantity. The inventory

reduction occurs when the quality order is completed through the validation step. The inventory

transaction is identified as a quality order.

Work classes are used to direct and/or limit the type of work order lines that warehouse workers can process on

a mobile device.

1. Go to Warehouse management > Setup > Work > Work classesWarehouse management > Setup > Work > Work classes .

2. Select NewNew  to create a work class.

3. In the header, set the following values:

Work class ID:Work class ID: QC Check

Enter a name that identifies the work class.

Descr iption:Descr iption: QC Check

Enter a short description that indicates what the work class is used for.

Work order type:Work order type: Quality in quality check

Select the type of work order that is created by the work class. When you set up quality control

work, always select Quality in quality check.

4. On the Valid put location typesValid put location types  FastTab, leave the Location typeLocation type field blank.

If you select a location type, you limit the locations where items can be put after they are picked. This field

is used when a location directive tries to resolve the location, or when a warehouse worker manually

specifies the location for the mobile device menu item.



Work templateWork template

Purchase ordersPurchase orders

Quality in quality checkQuality in quality check

For more information about work classes and how to create them, see Create a work class.

Work templates let you define the work operations that must be performed in the warehouse. Typically,

warehouse work operations consist of a pair of actions: a warehouse worker picks on-hand inventory up in one

location and then puts the picked inventory down in another location. A work template for quality control

defines the work operations for doing quality checks.

1. Go to Warehouse management > Setup > Work > Work templatesWarehouse management > Setup > Work > Work templates .

2. In the header, set the Work order typeWork order type field to Purchase orders.

3. On the Action Pane, select EditEdit.

4. Select a work template that should include a quality check step. In the Over viewOver view  section, in the WorkWork

templatetemplate field, select 51 PO Receipt.

5. In the Work template detailsWork template details  section, notice that the grid has two existing lines: one for Pick and one

for Put.

6. In the Work template detailsWork template details  section, select NewNew  to add a row for quality control to the grid. Notice

that the L ine numberLine number  field for the new line is set to 3.

7. On the new line, set the following values. Accept the default values for the remaining fields.

Work type:Work type: Quality check

Work class ID:Work class ID: Purchase

Quality check template name:Quality check template name: Dock check

Select the unique ID for the work class. You use this value to configure the menu items on the

mobile device and the types of work that those menu items can process.

8. On the Action Pane, select SaveSave to save your work so far.

You receive an informational message that states, "Invalid - Quality check must come directly after a

pick." Therefore, you must change the L ine numberLine number  value for the line that you just added.

9. Follow these steps to change the L ine numberLine number  value for the new line:

a. In the Work template detailsWork template details  section, select the line where the Work typeWork type field is set to Quality

check.

b. Select the Move upMove up or Move downMove down button to move the Quality check line so that it's after the Pick

line.

10. On the Action Pane, select SaveSave.

Next, create a work template for the quality check.

1. In the header of the Work templatesWork templates  page, change the value of the Work order typeWork order type field to Quality in

quality check.

2. On the Action Pane, select NewNew  to add a row to the grid in the Over viewOver view  section.

3. In the new row, set the following values:

Work template:Work template: 51 Quality Check

Enter a name for the template.
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Work template descr iption:Work template descr iption: 51 Quality Check

4. On the Action Pane, select SaveSave to make the Work template detailsWork template details  section available.

5. While the new template is still selected in the Over viewOver view  section, select NewNew  in the Work templateWork template

detailsdetails  section to add a row to the grid there.

6. In the new row, set the following values:

Work type:Work type: Pick

Work class ID:Work class ID: QC Check

Select the name of the work class that you created earlier for quality control work.

7. In the Work template detailsWork template details  section, select NewNew  again to add another row.

8. In the new row, set the following values:

Work type:Work type: Put

Work class ID:Work class ID: QC Check

Select the name of the work class that you created earlier for quality control work.

9. On the Action Pane, select SaveSave.

For more information about work templates, see Control warehouse work by using work templates and location

directives

Location directives are rules that help identify pick and put locations for inventory movement. For example, in a

sales order transaction, a location directive determines where the items will be picked and where the picked

items will be put. You must configure a location directive rule to define how failed quality checks will be handled.

1. Go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives .

2. In the left pane, set the Work order typeWork order type field to Purchase orders to work with location directives of that

type.

3. On the Action Pane, select NewNew  to create a location directive for quality checks.

4. In the header, set the following values:

Sequence number :Sequence number : Accept the default value.

Name:Name: 51 To Quality

5. On the Location directivesLocation directives  FastTab, set the following values. Accept the default values for the remaining

fields.

Work type:Work type: Put

Site:S ite: 5

Warehouse:Warehouse: 51

6. On the Action Pane select SaveSave to save your directive and make the L inesLines  FastTab available.

7. On the L inesLines  FastTab, select NewNew  to add a line to the grid.

8. On the new line, set the following values. Accept the default values for the remaining fields.

From quantity:From quantity: 1

To quantity:To quantity: 1000000

9. On the Action Pane, select SaveSave to save the new line and make the Location directive actionsLocation directive actions  FastTab
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Purchase putawayPurchase putaway

Purchase order line receivingPurchase order line receiving

available.

10. While the new line is still selected on the L inesLines  FastTab, select NewNew  on the Location directive actionsLocation directive actions

FastTab to add a row to the grid there, so that you can set up an action for the line.

11. In the new row, set the NameName field to Quality. Accept the default values for the remaining fields.

12. On the Action Pane, select SaveSave to make the Edit quer yEdit quer y  button on the Location directive actionsLocation directive actions

FastTab available.

13. While the line that you just added is still selected on the Location directive actionsLocation directive actions  FastTab, select EditEdit

quer yquer y  to open a dialog box where you can edit the query for the action.

14. On the RangeRange tab, select AddAdd to add a row to the query.

15. In the new row, set the following values:

Table:Table: Locations

Derived table:Derived table: Locations

Field:Field: Location

Criter ia:Cr iter ia: QMS

The QMS location is a warehouse location for quality.

16. Select OKOK to close the dialog box.

17. You must now change the sequence of purchase order location directives for warehouse 51. Save the new

51 To Quality location directive, refresh the page, and select the location directive in the list. Then use the

Move upMove up and Move downMove down buttons on the Action Pane to put the location directive for warehouse 51 in

the following order. (Before you select Move upMove up or Move downMove down, you must select a location directive in

the list.)

a. 51 To Quality

b. 51 PO Direct

c. 51 QMS

Configure a menu item so that mobile devices can perform the Quality CheckQuality Check function.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. In the list, select the Purchase put-awayPurchase put-away  menu item.

3. On the Action Pane, select EditEdit.

4. In the Work classesWork classes  section, select NewNew  to add a row to the grid.

5. In the new row, set the following values:

Work class ID:Work class ID: QC Check

Enter the name of the work class that you created earlier for quality control work.

Work order type:Work order type: Quality in quality check

6. On the Action Pane, select SaveSave.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. On the Action Pane, select NewNew .



 

Add the menu item to a mobile device menuAdd the menu item to a mobile device menu

Example scenario

Create a purchase orderCreate a purchase order

Process quality check receivingProcess quality check receiving

Receive pallet 1Receive pallet 1

3. In the header, set the following values:

Menu item name:Menu item name: PO line receiving

Title:Title: PO line receiving

Mode:Mode: Work

Use existing work :Use existing work : No

4. On the GeneralGeneral  FastTab, set the following values. Accept the default values for the remaining fields.

Work creation process:Work creation process: Purchase order line receiving and put away

Generate license plate:Generate license plate: Yes

Work template:Work template: 51 PO Receipt

5. On the Action Pane, select SaveSave.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menuWarehouse management > Setup > Mobile device > Mobile device menu.

2. In the left pane, select the InboundInbound menu.

3. On the Action Pane, select EditEdit.

4. In the Available menus and menu itemsAvailable menus and menu items column, select the new PO line receivingPO line receiving menu item.

5. Select the right arrow button to move PO line receivingPO line receiving to the Menu structureMenu structure column.

6. In the Menu structureMenu structure column, select PO line receivingPO line receiving, and then select the up arrow or down arrow

button to move the menu item to the desired position on the mobile device menu.

7. On the Action Pane, select SaveSave.

After you've made all the previously described sample data available and set it up, you can work through this

scenario to try out the Quality check feature. The values that are shown in this scenario assume that you're

working with the standard demo data, that you selected the USMFUSMF legal entity, and that you prepared the

sample records that are described earlier in this topic. This scenario also serves as an example that shows how

the feature can be used in a production setting.

1. Go to Procurement and sourcing > Purchase orders > All purchase ordersProcurement and sourcing > Purchase orders > All purchase orders .

2. On the Action Pane, select NewNew .

3. In the Create purchase orderCreate purchase order  dialog box, set the following values:

Vendor account:Vendor account: 104

Warehouse:Warehouse: 51

4. Select OKOK to close the dialog box and open the new purchase order.

5. On the Purchase order linesPurchase order lines  FastTab, the grid contains a new, blank line. On this line, set the following

values:

Item number :Item number : M9203

Quantity:Quantity: 3

Unit:Unit: PL

6. On the Action Pane, select SaveSave.

After the purchase order has been created, it can be received by using the PO line receivingPO line receiving menu item and

the functionality of the Quality check feature.



Receive pallet 2Receive pallet 2

1. Sign in to the warehouse app as a user for warehouse 51. (Enter 51 as the user ID and 1 as the password.)

2. Go to Inbound > PO line receivingInbound > PO line receiving.

3. In the PONUMPONUM field, enter the purchase order number.

4. Confirm the purchase order number.

5. In the L INENUMLINENUM field, enter the number of the purchase order line that is being received. Because the

order has only one line in this scenario, you will enter 1 in the L INENUMLINENUM field for each receiving step.

6. Confirm the line number.

7. In the QTYQTY field, enter the quantity to receive. Because the purchase order is for three pallets (PL) in this

scenario, and there are three receiving steps, you will enter 1 in the QTYQTY field for each receiving step.

8. Confirm the quantity.

The Quality checkQuality check page that appears has no entry fields. It has only the confirmation (check mark)

button at the bottom and the Menu button (≡) at the top. (The Menu button is sometimes referred to as

the hamburger or the hamburger button.) To expedite the quality check process, when the pallet passes

the quality check, the user just confirms the Quality checkQuality check page.

9. Select the confirmation button to pass the quality check for pallet 1 from line 1.

The Purchase orders: PutPurchase orders: Put page that appears shows details of the put work:

LOC:LOC: The system determined location

This location is the designated putaway location for purchase order receiving.

LP:LP: The system-generated License plate ID

Item:Item: M9203

Qty:Qty: 1 PL: 100 ea

The item description is also shown.

10. Confirm the putaway work.

On the TaskTask page for purchase order line receiving, you receive a "Work Completed" message. The

LINENUMLINENUM field is available so that you can start to receive the next pallet.



Receive pallet 3Receive pallet 3

For this scenario, pallet 2 will be rejected.

1. In the L INENUMLINENUM field, enter 1, and confirm the line number.

2. The QTYQTY field is now available. Enter 1, and confirm the quantity.

The Quality checkQuality check page appears. For this receipt, the pallet will be rejected for quality, and it will be put

into the QMS quality location.

3. Select the Menu button (≡) at the top of the page, and then, on the menu, select RejectReject.

4. On the TaskTask page that appears, enter QMSQMS  as the Put location to send the pallet to for further inspection.

The Quality in quality check : PutQuality in quality check : Put page that appears shows details of the put work:

LOC:LOC: QMS

This location is the designated putaway location for rejected quality receiving.

LP:LP: The system-generated License plate ID

Item:Item: M9203

Qty:Qty: 1 PL: 100 ea

The item description is also shown.

5. Confirm the putaway work.

On the TaskTask page for purchase order line receiving, you receive a "Work Completed" message. The

LINENUMLINENUM field is available so that you can start to receive the next pallet.

You've now completed the quality check and created a quality order for the rejected pallet. To view the order that

was created, go to Inventor y management > Periodic tasks > Quality management > Quality ordersInventor y management > Periodic tasks > Quality management > Quality orders .

Quality order testing can now be processed. Quality testing isn't covered in this topic.

For more information about quality management, see Quality management overview

For this scenario, pallet 3 will be accepted.

1. In the L INENUMLINENUM field, enter 1, and confirm the line number.

2. The QTYQTY field is now available. Enter 1, and confirm the quantity.

The Quality checkQuality check page appears. For this receipt, the pallet will be accepted for quality, and it will be put

into a bulk putaway location.

3. Select the confirmation button to pass the quality check.

The Purchase orders: PutPurchase orders: Put page that appears shows details of the put work:

LOC:LOC: The system determined location

This location is the designated putaway location for purchase order receiving.

LP:LP: The system-generated License plate ID

Item:Item: M9203

Qty:Qty: 1 PL: 100 ea

The item description is also shown.



NOTENOTE

4. Confirm the putaway work.

On the TaskTask page for purchase order line receiving, you receive a "Work Completed" message. The

LINENUMLINENUM field is available so that you can start to receive the next pallet.

5. Select the Menu button (≡) at the top of the page, and then, on the menu, select CancelCancel  to return to the

menu.

You can now close the mobile app.
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I receive the following error message: "Quality order %1 has been
generated. Cluster profile could not be found please check your
configuration."
Issue descriptionIssue description

Issue resolutionIssue resolution

Mixed license plate receiving doesn't work for any disposition code
except Credit.
Issue descriptionIssue description

Issue resolutionIssue resolution

When I run the Update product receipts periodic task, unconfirmed
purchase orders are confirmed.
Issue descriptionIssue description

Issue resolutionIssue resolution

This topic describes how to fix common issues that you might encounter while you work with inbound

warehouse operations in Microsoft Dynamics 365 Supply Chain Management.

This error message is related to a receiving process where quality management (QMS) is turned on. Depending

on the configurations in your environment, additional details about the transaction that is generating the error

message might help fix the issue.

First, review the cluster picking setup, and make sure that your cluster profiles are set up correctly. You can't use

a mobile device menu item for cluster picking unless cluster profiles are set up. Depending on your

environment, you might also have to review other related configurations.

When the ActionAction field for a disposition code is set to Credit or Scrap, you can use only the Mixed license plate

receiving menu item to process returned items.

Microsoft has evaluated this issue and has determined that it's a feature limitation. Currently, only disposition

codes where the ActionAction field is set to Credit or Scrap are supported for mixed license plate receiving.

After you run the Update product receipts periodic task, the system automatically confirms unconfirmed

purchase orders that have an inventory transaction status of Registered.

A new inbound load handling feature, Over receipt of load quantities, fixes this issue. To turn on this feature, go

to Feature management, and turn on the following features (in the order that they are listed in):

1. Associate purchase order inventory transactions with load

2. Over receipt of load quantities

For more information, see Post registered product quantities against purchase orders.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/troubleshoot-warehouse-inbound.md
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Inventory reservation hierarchy

Flexible reservation for batch-tracked items
Business scenarioBusiness scenario

When an inventory reservation hierarchy of the "Batch-below[location]" type is associated with products,

businesses that sell batch-tracked products and run their logistics as operations that are enabled for the

Microsoft Dynamics 365 Warehouse Management System (WMS) can't reserve specific batches of those

products for customer sales orders.

In a similar way, specific license plates can't be reserved for products on sales orders when those products are

associated with the default reservation hierarchy.

This topic describes the inventory reservation policy that lets these businesses reserve specific batches or

license plates, even when the products are associated with a "Batch-below[location]" reservation hierarchy.

This section summarizes the existing inventory reservation hierarchy.

The inventory reservation hierarchy dictates that, as far as storage dimensions are concerned, the demand order

carries the mandatory dimensions of site, warehouse, and inventory status, whereas the warehouse logic is

responsible for assigning a location to the requested quantities and reserving the location. In other words, in the

interactions between the demand order and the warehouse operations, the demand order is expected to indicate

where the order must be shipped from (that is, what site and warehouse). The warehouse then relies on its logic

to find the required quantity in the warehouse premises.

However, to reflect the operational model of the business, tracking dimensions (batch and serial numbers) are

subject to more flexibility. An inventory reservation hierarchy can accommodate scenarios where the following

conditions apply:

The business relies on its warehouse operations to manage picking of quantities that have batch or serial

numbers after the quantities have been found in the warehousing storage space. This model is often referred

to as Batch-below[location]. It's typically used when a product's batch or serial number identification isn't

important to the customers who place the demand with the selling company.

If batch or serial numbers are part of a customer's order specification, and they are recorded on the demand

order, the warehouse operations that find the quantities in the warehouse are constrained by the specific

requested numbers and aren't allowed to change them. This model is referred to as Batch-above[location].

In these scenarios, the challenge is that only one inventory reservation hierarchy can be assigned to each

released product. Therefore, for the WMS to handle tracked items, after the hierarchy assignment determines

when the batch or serial number should be reserved (either when the demand order is taken or during the

warehouse picking work), this timing can't be changed on an ad-hoc basis.

In this scenario, a company uses an inventory strategy where finished goods are tracked by batch numbers. This

company also uses the WMS workload. Because this workload has well-equipped logic for planning and running

warehouse picking and shipping operations for batch-enabled items, most of the finished items are associated

with a "Batch-below[location]" inventory reservation hierarchy. The advantage of this type of operational setup

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/flexible-warehouse-level-dimension-reservation.md
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NOTENOTE

is that decisions (which are effectively reservation decisions) about which batches to pick and where to put them

in the warehouse are postponed until the warehouse picking operations start. They aren't made when the

customer's order is placed.

Although the "Batch-below[location]" reservation hierarchy serves the company's business goals well, many of

the company's established customers require the same batch that they previously purchased when they reorder

products. Therefore, the company is looking for flexibility in the way that the batch reservation rules are

handled, so that, depending on the customers' demand for the same item, the following behaviors occur :

A batch number can be recorded and reserved when the order is taken by the sales processor, and it can't be

changed during warehouse operations and/or taken by other demands. This behavior helps guarantee that

the batch number that was ordered is shipped to the customer.

If the batch number isn't important to the customer, the warehouse operations can determine a batch

number during picking work, after sales order registration and reservation have been done.

To accommodate the desired flexibility in the batch reservation behavior for items that are associated with a

"Batch-below[location]" inventory reservation hierarchy, inventory managers must select the AllowAllow

reser vation on demand orderreser vation on demand order  check box for the Batch numberBatch number  level on the Inventor y reser vationInventor y reser vation

hierarchieshierarchies  page.

When the Batch numberBatch number  level in the hierarchy is selected, all dimensions above that level and up through the

LocationLocation level will be automatically selected. (By default, all dimensions above the LocationLocation level are

preselected.) This behavior reflects the logic where all dimensions in the range between the batch number and

location are also automatically reserved after you reserve a specific batch number on the order line.

The Allow reser vation on demand orderAllow reser vation on demand order  check box applies only to reservation hierarchy levels that are below the

warehouse location dimension.

Batch numberBatch number  and License plateLicense plate are the only levels in the hierarchy that are open for the flexible reservation policy. In

other words, you can't select the Allow reser vation on demand orderAllow reser vation on demand order  check box for the LocationLocation or Serial numberSerial number

level.

If your reservation hierarchy includes the serial number dimension (which must always be below the Batch numberBatch number

level), and if you've turned on batch-specific reservation for the batch number, the system will continue to handle serial

number reservation and picking operations, based on the rules that apply to the "Serial-below[location]" reservation

policy.

At any point, you can allow batch-specific reservation for an existing "Batch-below[location]" reservation

hierarchy in your deployment. This change won't affect any reservations and open warehouse work that were

created before the change occurred. However, the Allow reser vation on demand orderAllow reser vation on demand order  check box can't be



NOTENOTE

Reserve a specific batch number for a customer orderReserve a specific batch number for a customer order

Example scenario: Batch number allocation

Set up an inventory reservation hierarchy to allow batch-specific reservationSet up an inventory reservation hierarchy to allow batch-specific reservation

cleared if inventory transactions of the Reser ved orderedReser ved ordered, Reser ved physicalReser ved physical , or OrderedOrdered issue type exist

for one or more items that are associated with that reservation hierarchy.

If an item's existing reservation hierarchy doesn't allow batch specification on the order, you can reassign it to a

reservation hierarchy that does allow batch specification, provided that the hierarchy level structure is the same in both

hierarchies. Use the Change reser vation hierarchy for itemsChange reser vation hierarchy for items function to do the reassignment. This change might be

relevant when you want to prevent flexible batch reservation for a subset of batch-tracked items but allow it for the rest

of the product portfolio.

Regardless of whether you've selected the Allow reser vation on demand orderAllow reser vation on demand order  check box, if you don't want

to reserve a specific batch number for the item on an order line, default warehouse operations logic that is valid

for a "Batch-below[location]" reservation hierarchy will still apply.

After a batch-tracked item's "Batch-below[location]" inventory reservation hierarchy is set up to allow

reservation of specific batch numbers on sales orders, sales order processors can take customer orders for the

same item in one of the following ways, depending on the customer's request:

Enter order details without specifying a batch numberEnter order details without specifying a batch number  – This approach should be used when the

product's batch specification isn't important to the customer. All existing processes that are associated with

handling an order of this type in the system remain unchanged. No additional considerations are required on

the part of users.

Enter order details and reser ve a specific batch numberEnter order details and reser ve a specific batch number  – This approach should be used when the

customer requests a specific batch. Typically, customers will request a specific batch when they are

reordering a product that they previously purchased. This type of batch-specific reservation is referred to as

order-committed reservation.

The following set of rules is valid when quantities are processed, and a batch number is committed to a specific

order :

To allow reservation of a specific batch number for an item under the "Batch-below[location]" reservation

policy, the system must reserve all dimensions up through location. This range typically includes the license

plate dimension.

Location directives aren't used when picking work is created for a sales line that uses order-committed batch

reservation.

During warehouse processing of work for order-committed batches, neither the user nor the system is

allowed to change the batch number. (This processing includes exception handling.)

The following example shows the end-to-end flow.

For this example, demo data must be installed, and you must use the USMFUSMF demo data company.

1. Go to Warehouse managementWarehouse management > SetupSetup > Inventor y > Reser vation hierarchyInventor y > Reser vation hierarchy .

2. Select NewNew .

3. In the NameName field, enter a name (for example, BatchFlexBatchFlex).

4. In the Descr iptionDescr iption field, enter a description (for example, Batch below flexibleBatch below flexible).

5. In the SelectedSelected field, select Ser ial numberSerial number  and OwnerOwner , and then select the left arrow button to move them

to the AvailableAvailable field.



    

Create a new released productCreate a new released product

Enter sales order detailsEnter sales order details

6. Select OKOK.

7. In the row for the Batch numberBatch number  dimension level, select the Allow reser vation on demand orderAllow reser vation on demand order  check

box. The L icense plateLicense plate and LocationLocation levels are automatically selected, and you can't clear the check boxes

for them.

8. Select SaveSave.

WA REH O USEWA REH O USE B ATC H  N UM B ERB ATC H  N UM B ER LO C AT IO NLO C AT IO N L IC EN SE P L AT EL IC EN SE P L AT E Q UA N T IT YQ UA N T IT Y

24 B11 BULK-001 None 10

24 B11 FL-001 LP11 10

24 B22 FL-002 LP22 10

1. Set the product's three master data parameters by using these values:

In the Storage dimension groupStorage dimension group field, select WareWare.

In the Tracking dimension groupTracking dimension group field, select Batch-PhyBatch-Phy .

In the Reser vation hierarchyReser vation hierarchy  field, select BatchFlexBatchFlex.

2. Create two batch numbers, such as B11B11  and B22B22 .

3. Add item quantities to on-hand stock by using the following values.

NOTENOTE

1. Go to Sales and marketingSales and marketing > Sales ordersSales orders  > All sales ordersAll sales orders .

2. Select NewNew .

3. On the sales order header, in the Customer accountCustomer account field, enter US-003US-003 .

4. Add a line for the new item, and enter 1010  as the quantity. Make sure that the WarehouseWarehouse field is set to

2424 .

5. On the Sales order linesSales order lines  FastTab, select Inventor yInventor y , and then, in the MaintainMaintain group, select BatchBatch

reser vationreser vation. The Batch reser vationBatch reser vation page shows a list of batches that are available for reservation for

the order line. For this example, it shows a quantity of 2020  for batch number B11B11  and a quantity of 1010  for

batch number B22B22 . Note that the Batch reser vationBatch reser vation page cannot be accessed from a line if the item on

that line is associated with "Batch-below[location]" reservation hierarchy unless it is set up to allow

batch-specific reservation.

To reserve a specific batch for a sales order, you must use the Batch reser vationBatch reser vation page.

If you enter the batch number directly on the sales order line, the system will behave as though you entered a

specific batch value for an item that is subject to the "Batch-below[location]" reservation policy. When you save

the line, you will receive a warning message. If you confirm that the batch number should be specified directly on

the order line, the line won't be handled by the regular warehouse management logic.

If you reserve the quantity from the Reser vationReser vation page, no specific batch will be reserved, and the execution of

warehouse operations for the line will follow the rules that are applicable under the "Batch-below[location]"

reservation policy.

In general, this page works and is interacted with in the same way that it works and is interacted with for

items that have an associated reservation hierarchy of the "Batch-above[location]" type. However, the



following exceptions apply:

The Batch numbers committed to source lineBatch numbers committed to source line FastTab shows the batch numbers that are reserved

for the order line. The batch values in the grid will be shown throughout the fulfillment cycle of the

order line, including the warehouse processing stages. By contrast, on the Over viewOver view  FastTab, regular

order line reservation (that is, reservation that is done for the dimensions above the LocationLocation level) is

shown in the grid up to the point when warehouse work is created. The work entity then takes over

the line reservation, and the line reservation no longer appears on the page. The Batch numbersBatch numbers

committed to source linecommitted to source line FastTab helps guarantee that the sales order processor can view the batch

numbers that were committed to the customer's order at any point during its lifecycle, up through

invoicing.

In addition to reserving a specific batch, a user can manually select the batch's specific location and

license plate instead of letting the system automatically select them. This capability is related to the

design of the order-committed batch reservation mechanism. As was mentioned earlier, when a batch

number is reserved for an item under the "Batch-below[location]" reservation policy, the system must

reserve all dimensions up through location. Therefore, warehouse work will carry the same storage

dimensions that were reserved by the users who worked with the orders, and it might not always

represent the item storage placement that is convenient, or even possible, for picking operations. If

order processors are aware of the warehouse constraints, they might want to manually select the

specific locations and license plates when they reserve a batch. In this case, the user must use the

Display dimensionsDisplay dimensions  functionality on the page header, and must add the location and license plate in

the grid on the Over viewOver view  FastTab.

6. On the Batch reser vationBatch reser vation page, select the line for batch B11B11 , and then select Reser ve lineReser ve line. There is no

designated logic for assigning locations and license plates during automatic reservation. You can

manually enter the quantity in the Reser vationReser vation field. Notice that, on the Batch numbers committedBatch numbers committed

to source lineto source line FastTab, batch B11B11  is shown as CommittedCommitted.



Review and process warehouse work that has order-committed batch numbersReview and process warehouse work that has order-committed batch numbers

NOTENOTE
Reservation of the quantity on a sales order line can be done across multiple batches. Likewise, reservation of the

same batch can be done against multiple locations and license plates (if license plates are enabled for the

locations).

Reservation of a specific batch for the quantity on a sales order line can also be partial. For example, the total

quantity of 100 units can be reserved so that a specific batch is committed to 20 units, whereas 80 units are

reserved at the site and warehouse levels for any available batch. In this case, the WMS will handle picking

operations by using two separate work lines.

7. Go to Product information managementProduct information management > ProductsProducts  > Released productsReleased products . Select your item, and

then select Manage inventor yManage inventor y  > ViewView  > TransactionsTransactions .

8. Review the item's inventory transactions that are related to the sales order line reservation.

A transaction where the ReferenceReference field is set to Sales orderSales order  and the IssueIssue field is set to Reser vedReser ved

physicalphysical  represents the order line reservation for the inventory dimensions above the LocationLocation

level. According to the item's inventory reservation hierarchy, those dimensions are site, warehouse,

and inventory status.

A transaction where the ReferenceReference field is set to Order-committed reser vationOrder-committed reser vation and the IssueIssue field

is set to Reser ved physicalReser ved physical  represents the order line reservation for the specific batch and all

inventory dimensions above it. According to the item's inventory reservation hierarchy, those

dimensions are batch number and location. In this example, the location is Bulk-001Bulk-001 .

9. On the sales order header, select WarehouseWarehouse > ActionsActions  > Release to warehouseRelease to warehouse. The order line is

now waved, and a load and work are created.

1. On the Sales order linesSales order lines  FastTab, select WarehouseWarehouse > Work detailsWork details .

The work that handles the picking operation for batch quantities that are committed to the sales order

line has the following characteristics:

To create work, the system uses work templates but not location directives. All the standard

settings that are defined for work templates, such as a maximum number of pick lines or a specific

unit of measure, will be applied to determine when new work should be created. However, the

rules that are associated with location directives for identifying pick locations aren't considered,

because the order-committed reservation already specifies all the inventory dimensions. Those

inventory dimensions include the dimensions at the warehouse storage level. Therefore, the work

inherits those dimensions without having to consult location directives.

The batch number isn't shown on the pick line (as is the case for the work line that is created for an

item that has an associated "Batch-above[location]" reservation hierarchy.) Instead, the "from"

batch number and all other storage dimensions are shown on the work line's work inventory

transaction that is referenced from the associated inventory transactions.



Flexible license plate reservation
Business scenarioBusiness scenario

After work is created, the item's inventory transaction where the ReferenceReference field is set to Order-Order-

committed reser vationcommitted reser vation is removed. The inventory transaction where the ReferenceReference field is set

to WorkWork now holds the physical reservation on all the quantity's inventory dimensions.

Warehouse operations can proceed to handle execution of the work in the usual manner. However,

the instructions on the mobile device will instruct the worker to pick a specific batch number. In

warehouse environments where locations are license plate–controlled, after a worker reaches a

location that stores the same batch on multiple license plates, he or she can pick from any license

plate that isn't already reserved (for example, by another order-committed reservation or work

that originates from a reservation of that type.)

If it turns out to be impractical to pick from the location that is specified on the work line, the

warehouse operators can use one of the following actions to redirect picking of the specific batch

from a more convenient location:

The standard Overr ide locationOverr ide location action on a mobile device (provided that the warehouse

worker's Allow pick location overr ideAllow pick location overr ide setting is enabled)

The Change locationChange location action on the Work list detailsWork list details  page.

2. On the mobile device, finish picking and putting the work.

The quantity of 1010  for batch number B11B11  is now picked for the sales order line and put in the BaydoorBaydoor

location. At this point, it's ready to be loaded onto the truck and dispatched to the customer's address.

In this scenario, a company uses warehouse management and work processing, and handles load planning at

the level of individual pallets/containers outside Supply Chain Management before work is created. These

containers are represented by license plates in the inventory dimensions. Therefore, for this approach, specific



Turn on flexible license plate reservationTurn on flexible license plate reservation

Reserve a specific license plate on the sales orderReserve a specific license plate on the sales order

license plates must be pre-assigned to sales order lines before picking work is done. The company is looking for

flexibility in the way that the license plate reservation rules are handled, so that the following behaviors occur :

A license plate can be recorded and reserved when the order is taken by the sales processor, and it can't be

taken by other demands. This behavior helps guarantee that the license plate that was planned is shipped to

the customer.

If the license plate isn't already assigned to a sales order line, warehouse personnel can select a license plate

during picking work, after sales order registration and reservation are completed.

Before you can use flexible license plate reservation, two features must be turned on in your system. Admins can

use the feature management settings to check the status of the features and turn them on if they are required.

You must turn on the features in the following order :

1. Feature name:Feature name: Flexible warehouse-level dimension reservation

2. Feature name:Feature name: Flexible order-committed license plate reservation

To enable license plate reservation on an order, you must select the Allow reser vation on demand orderAllow reser vation on demand order

check box for the L icense plateLicense plate level on the Inventor y reser vation hierarchiesInventor y reser vation hierarchies  page for the hierarchy that

is associated with the relevant item.

You can enable license plate reservation on the order at any point in your deployment. This change won't affect

any reservations or open warehouse work that were created before the change occurred. However, you can't

clear the Allow reser vation on demand orderAllow reser vation on demand order  check box if open outbound inventory transactions that have

an issue status of On order, Reserved ordered, or Reserved physical exist for one or more items that are

associated with that reservation hierarchy.

Even if the Allow reser vation on demand orderAllow reser vation on demand order  check box is selected for the L icense plateLicense plate level, it's still

possible not to reserve a specific license plate on the order. In this case, the default warehouse operations logic

that is valid for the reservation hierarchy applies.

To reserve a specific license plate, you must use an Open Data Protocol (OData) process.In the application, you

can do this reservation directly from a sales order by using the Order-committed reser vations per licenseOrder-committed reser vations per license

plateplate option of the Open in ExcelOpen in Excel  command. In the entity data that is opened in the Excel add-in, you must

enter the following reservation-related data and then select PublishPublish to send the data back to Supply Chain

Management:

Reference (Only the Sales order value is supported.)

Order number (The value can be derived from the lot.)

Lot ID

License plate

Quantity

If you must reserve a specific license plate for a batch-tracked item, use the Batch reser vationBatch reser vation page, as

described in the Enter sales order details section.

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/odata


NOTENOTE

Example scenario: Set up and process an order-committed license
plate reservation

Make demo data availableMake demo data available

Create an inventory reservation hierarchy that allows for license plate reservationCreate an inventory reservation hierarchy that allows for license plate reservation

Create two released productsCreate two released products

When the sales order line that uses an order-committed license plate reservation is processed by warehouse

operations, location directives aren't used.

If a warehouse work item consists of lines that equal a complete pallet and have license plate–committed

quantities, you can optimize the picking process by using a mobile device menu item where the Handle byHandle by

license platelicense plate option is set to Yes. A warehouse worker can then scan a license plate to complete a pick instead

of having to scan the items from the work one by one.

Because the Handle by license plateHandle by license plate functionality doesn't support work that covers multiple pallets, it's better

to have a separate work item for different license plates. To use this approach, add the Order-committedOrder-committed

license plate IDlicense plate ID field as a work header break on the Work templateWork template page.

For the order-committed work creation process, an "order-committed inventory dimension" value will be assigned to the

picking work lines, and it won't be possible to view the license plate value directly. Only the User directed process is

supported when setting up a mobile device menu item.

This scenario shows how to set up and process an order-committed license plate reservation.

This scenario refers to values and records that are included in the standard demo data that is provided for

Supply Chain Management. If you want to work through the scenario by using the values that are provided here,

be sure to work on an environment where the demo data is installed. Additionally, set the legal entity to USMFUSMF

before you begin.

1. Go to Warehouse management > Setup > Inventor y > Reser vation hierarchyWarehouse management > Setup > Inventor y > Reser vation hierarchy .

2. Select NewNew .

3. In the NameName field, enter a value (for example, FlexibleLP).

4. In the Descr iptionDescr iption field, enter a value (for example, Flexible LP reservation).

5. In the SelectedSelected list, select Batch numberBatch number , Ser ial numberSerial number , and OwnerOwner .

6. Select the RemoveRemove button  to move the selected records to the AvailableAvailable list.

7. Select OKOK.

8. In the row for the L icense plateLicense plate dimension level, select the Allow reser vation on demand orderAllow reser vation on demand order  check

box. The LocationLocation level is automatically selected, and you can't clear the check box for it.

9. Select SaveSave.

1. Go to Product information management > Products > Released productsProduct information management > Products > Released products .

2. On the Action Pane, select NewNew .



Create a sales order and reserve a specific license plateCreate a sales order and reserve a specific license plate
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Item1 24 FL-010 LP01 10

Item1 24 FL-011 LP02 10

Item2 24 FL-010 LP01 5

Item2 24 FL-011 LP02 5

NOTENOTE

3. In the New released productNew released product dialog box, set the following values:

Product number :Product number : Item1

Item number :Item number : Item1

Item model group:Item model group: FIFO

Item group:Item group: Audio

Storage dimension group:Storage dimension group: Ware

Tracking dimension group:Tracking dimension group: None

Reser vation hierarchy:Reser vation hierarchy: FlexibleLP

4. Select OKOK to create the product and close the dialog box.

5. The new product is opened. On the WarehouseWarehouse FastTab, set the Unit sequence group IDUnit sequence group ID field to ea.

6. Repeat the previous steps to create a second product that has the same settings, but set the ProductProduct

numbernumber  and Item numberItem number  fields to Item2.

7. On the Action Pane, on the Manage inventor yManage inventor y  tab, in the ViewView  group, select On-hand inventor yOn-hand inventor y .

Then select Quantity adjustmentQuantity adjustment.

8. Adjust the on-hand inventory of the new items as specified in the following table.

You must create the two license plates and use locations that allow for mixed items, such as FL-010 and FL-011.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. Select NewNew .

3. In the Create sales orderCreate sales order  dialog box, set the following values:

Customer account:Customer account: US-001

Warehouse:Warehouse: 24

4. Select OKOK to close the Create sales orderCreate sales order  dialog box and open the new sales order.

5. On the Sales order linesSales order lines  FastTab, add a line that has the following settings:

Item number :Item number : Item1

Quantity:Quantity: 10

6. Add a second sales order line that has the following settings:

Item number :Item number : Item2

Quantity:Quantity: 5

7. Select SaveSave.



NOTENOTE

NOTENOTE

8. On the L ine detailsL ine details  FastTab, on the SetupSetup tab, make a note of the Lot IDLot ID value for each line. These

values will be required during reservation of specific license plates.

To reserve a specific license plate, you must use the Order-committed reser vations per license plateOrder-committed reser vations per license plate data

entity. To reserve a batch-tracked item on a specific license plate, you can also use the Batch reser vationBatch reser vation page,

as described in the Enter sales order details section.

If you enter the license plate directly on the sales order line and confirm it to the system, warehouse management

processing won't be used for the line.

9. Select Open in Microsoft OfficeOpen in Microsoft Office, select Order-committed reser vations per license plateOrder-committed reser vations per license plate, and

download the file.

10. Open the downloaded file in Excel, and select Enable editingEnable editing to enable the Excel add-in to run.

11. If you're running the Excel add-in for the first time, select Trust this Add-inTrust this Add-in .

12. If you're prompted to sign in, select S ign inSign in , and then sign in by using the same credentials that you used

to sign in to Supply Chain Management.

13. To reserve an item on a specific license plate, in the Excel add-in, select NewNew  to add a reservation line, and

then set the following values:

Lot ID:Lot ID: Enter the Lot IDLot ID value that you found for the sales order line for Item1.

L icense plate:L icense plate: LP02

Reser vedInventor yQuantity:Reser vedInventor yQuantity: 10

14. Select NewNew  to add another reservation line, and set the following values:

Lot ID:Lot ID: Enter the Lot IDLot ID value you found for the sales order line for Item2.

L icense plate:L icense plate: LP02

Reser vedInventor yQuantity:Reser vedInventor yQuantity: 5

15. In the Excel add-in, select PublishPublish to send the data back to Supply Chain Management.

The reservation line will appear in the system only if publishing is completed without errors.

16. Go back to Supply Chain Management.

17. To review the item's reservation, on the Sales order linesSales order lines  FastTab, on the Inventor yInventor y  menu, select

Maintain > Reser vationMaintain > Reser vation. Notice that, for the sales order line for Item1, inventory of 10 is reserved, and

for the sales order line for Item2, inventory of 5 is reserved.

18. To review inventory transactions that are related to the sales order line reservation, on the Sales orderSales order

lineslines  FastTab, on the Inventor yInventor y  menu, select View > TransactionsView > Transactions . Notice that there are two

transactions that are related to the reservation: one where the ReferenceReference field is set to Sales order and

one where the ReferenceReference field is set to Order-committed reservation.



Review and process warehouse work with order-committed license plates assignedReview and process warehouse work with order-committed license plates assigned

Exception handling of warehouse work that has order-committed
batch numbers

NOTENOTE
A transaction where the ReferenceReference field is set to Sales order represents the order line reservation for inventory

dimensions that are above the LocationLocation level (site, warehouse, and inventory status). A transaction where the

ReferenceReference field is set to Order-committed reservation represents the order line reservation for the specific license

plate and location.

19. To release the sales order, on the Action Pane, on the WarehouseWarehouse tab, in the ActionsActions  group, select

Release to warehouseRelease to warehouse.

NOTENOTE

NOTENOTE

1. On the Sales order linesSales order lines  FastTab, on the WarehouseWarehouse menu, select Work detailsWork details .

As when reservation is done for a specific batch, the system doesn't use location directives when it

creates the work for the sales order that uses license plate reservation. Because the order-committed

reservation specifies all the inventory dimensions, including the location, location directives don't have to

be used, because those inventory dimensions are just entered in the work. They are shown in the FromFrom

inventor y dimensionsinventor y dimensions  section on the Work inventor y transactionsWork inventor y transactions  page.

After the work is created, the item's inventory transaction where the ReferenceReference field is set to Order-committed

reservation is removed. The inventory transaction where the ReferenceReference field is set to Work now holds the

physical reservation for all the quantity's inventory dimensions.

2. On the mobile device, finish picking and putting the work by using a menu item where the Handle byHandle by

license platelicense plate check box is selected.

The Handle by license plateHandle by license plate functionality helps you process the whole license plate. If you must process part of

the license plate, you can't use this functionality.

We recommend that you have separate work generated for each license plate. To achieve this result, use the

Work header breaksWork header breaks feature on the Work templateWork template page.

License plate LP02 is now picked for sales order lines and put to the Baydoor location. At this point, it's

ready to be loaded and dispatched to the customer.

Warehouse work for picking order-committed batch numbers is subject to the same standard warehouse

exception handling and actions as regular work. In general, the open work or work line can be canceled, it can be

interrupted because a user location is full, it can be short-picked, and it can be updated because of a movement.

Likewise, the picked quantity of work that has already been completed can be reduced, or the work can be

reversed.

The following key rule is applied to all these exception handling actions: the batch number that was reserved for

the customer can never be replaced with a different batch number, but its storage dimensions (location and

license plate) can be changed through either a manual update by the user or an automatic update by the system.

The automatic update is based on the same random assignment of storage dimensions that applied when a

specific batch was automatically reserved but no storage dimensions were specified.



Example scenarioExample scenario

NOTENOTE

Override the pick location on the open workOverride the pick location on the open work

KEY  SET UPKEY  SET UP
PA RA M ET ERPA RA M ET ER

B ATC H  Q UA N T IT Y  ISB ATC H  Q UA N T IT Y  IS
AVA IL A B L EAVA IL A B L E KEY  USER ST EP SKEY  USER ST EP S WA REH O USE W O RKWA REH O USE W O RK

O RDER- C O M M IT T EDO RDER- C O M M IT T ED
B ATC H  RESERVAT IO NB ATC H  RESERVAT IO N

An example of this scenario is a situation where previously completed work is being unpicked by using the

Reduce picked quantityReduce picked quantity  function. This example assumes that you've already completed the steps that are

described in Example scenario: Batch number allocation. It continues from that example.

1. Go to Warehouse managementWarehouse management > LoadsLoads  > Active loadsActive loads .

2. Select the load that was created in connection with the shipment of your sales order.

3. From the Load order linesLoad order lines  FastTab, select Reduce picked quantityReduce picked quantity .

4. On the Reduce picked quantityReduce picked quantity  page, in the Move to locationMove to location field, select FL-001FL-001 .

5. In the Move to license plateMove to license plate field, select LP33LP33 .

6. In the grid, in the Inventor y quantity to unpickInventor y quantity to unpick field, enter 1010 .

7. Select OKOK.

Here are the results of the unpicking action:

The status of the previously closed work is set to CanceledCanceled.

New work of the Inventor y movementInventor y movement type is created for the unpicked quantity of 1010  for batch number

B11B11 . This work represents the movement from the BaydoorBaydoor  location to license plate LP33LP33  in location FL-FL-

001001 . The status is set to ClosedClosed.

The system re-reserves the batch number that was originally ordered, and assigns the location and license

plate IDs. (This process is equivalent to running the Reser ve lineReser ve line function for the order line for a given batch

number). As a result, batch B11B11  is shown as committed on the Batch numbers committed to source lineBatch numbers committed to source line

FastTab of the Batch reser vationBatch reser vation page, and the Reser vationReser vation field contains a quantity of 1010  for batch

number B11B11 . Additionally, the LocationLocation field is set to FL-001FL-001 , and the L icense plateLicense plate field is set to LP11LP11 .

(You can add these fields to the grid if they aren't visible.)

The following tables provide an overview that shows how the system handles order-committed batch

reservation for specific warehouse actions. To interpret the content in the tables, assume that each warehouse

action is run in the context of existing warehouse work that originates from an order-committed batch

reservation, or that execution of each warehouse action affects work of that type.

In these tables, the "Batch quantity is available" column indicates whether a batch quantity is available in addition to the

quantity that is either already reserved for the current order-committed reservations or already reserved by the

warehouse work that originates from reservations of that type.



The Allow pickAllow pick
location overridelocation override
option is enabled on
the worker.

Yes On the current work,
the following actions
occur:

Not applicable

No The OverrideOverride
locationlocation action isn't
possible. It fails, and
an error is thrown.

Not applicable

KEY  SET UPKEY  SET UP
PA RA M ET ERPA RA M ET ER

B ATC H  Q UA N T IT Y  ISB ATC H  Q UA N T IT Y  IS
AVA IL A B L EAVA IL A B L E KEY  USER ST EP SKEY  USER ST EP S WA REH O USE W O RKWA REH O USE W O RK

O RDER- C O M M IT T EDO RDER- C O M M IT T ED
B ATC H  RESERVAT IO NB ATC H  RESERVAT IO N

Full button – Split a work line because of overflow on the user locationFull button – Split a work line because of overflow on the user location

1. Select the
OverrideOverride
locationlocation
menu item on
the
warehouse
app when you
start picking
work.

2. Select
SuggestSuggest .

3. Confirm the
new location
that is
suggested
based on
batch
quantity
availability.

The location
on the pick
line is
updated to
the new
location. (If
the location is
license plate–
controlled, a
random
license plate is
assigned to
the work
inventory
transaction,
and the
worker can
pick from any
license plate
that has
available
quantity.)

If the quantity
is found on
more than
one license
plate in the
new location,
the original
pick line is
split into
multiple lines
to match each
license plate.

1. Select the
OverrideOverride
locationlocation
menu item on
the
warehouse
app when you
start picking
work.

2. Manually
enter a
location.
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The Allow splittingAllow splitting
of workof work option is
enabled on the
mobile device menu
item.

Not applicable Not applicable

Reduce the picked quantity of completed work (from a load)Reduce the picked quantity of completed work (from a load)
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Not applicable Yes The quantity is re-
reserved for the
same batch. The
system randomly
assigns a location
and license plate (if
the location is license
plate–controlled)
where the quantity is
available.

No See the previous row. See the previous row. The quantity is re-
reserved for the
same batch, and for
the same location
and license plate (if
the location is license
plate–controlled) that
were entered during
unpicking.

Move an item within a warehouseMove an item within a warehouse

NOTENOTE

1. Select the
FullFull menu
item on the
warehouse
app when you
process
picking work.

2. In the PickPick
QtyQty  field,
enter a partial
quantity of
the required
pick to
indicate the
full capacity.

On the
current work,
the quantity
is updated to
the remaining
quantity that
must be
picked.

New work for
the picked
quantity is
created and
closed.

1. Open the
ReduceReduce
pickedpicked
quantityquantity
page from the
load line.

2. Enter the full
quantity to
unpick.

3. Select a
"move to"
location/licens
e plate.

Work that is
associated
with the load
line is
canceled.

New work for
the inventory
movement is
created and
closed.

This warehouse action is applicable only to movement of the Work creation processWork creation process type, not to movement by

template.
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The AllowAllow
movement ofmovement of
inventor y withinventor y with
associated workassociated work
option is enabled on
the worker.

Yes All existing
reservations that are
affected by the
quantity movement
from the given
location are re-
reserved for the
same batch. The
system randomly
assigns a location
and license plate (if
the location is license
plate–controlled)
where the quantity is
available.

No See the previous row. See the previous row. All existing
reservations that are
affected by the
quantity movement
from the given
location are re-
reserved for the
same batch, and for
the new "to" location
and license plate (if
the location is license
plate–controlled).

Reverse the picked quantity of completed work (from a load or a wave)Reverse the picked quantity of completed work (from a load or a wave)
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Not applicable Yes All work that is
associated with the
load is canceled.

The quantity is re-
reserved for the
same batch. The
system randomly
assigns a location
and license plate (if
the location is license
plate–controlled)
where the quantity is
available.

No See the previous row. See the previous row. The quantity is re-
reserved for the
same batch, and for
the location and
license plate where
the quantity was left
upon reversal.

1. Start a
movement on
the
warehouse
app.

2. Enter "from"
and "to"
locations.

On all existing
work that is
affected by
the move, the
pick location
is updated to
the new "to"
location.

New work for
the inventory
movement is
created and
closed.

1. Open the
ReverseReverse
workwork page.

2. On the
request page,
select the
Leave itemsLeave items
at currentat current
locationlocation
option.



Yes The quantity is re-
reserved for the
same batch. The
system randomly
assigns a location
and license plate (if
the location is license
plate–controlled)
where the quantity is
available.

No See the previous row. See the previous row. The quantity is re-
reserved for the
same batch, and for
the location and
license plate that the
quantity was
assigned to upon
reversal.

Yes/No Reversal isn't
supported.

Not applicable

Yes/No Reversal isn't
supported.

Not applicable
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Short-pick a quantity – Register the quantity as physically not found at the location/license plate while you perform picking workShort-pick a quantity – Register the quantity as physically not found at the location/license plate while you perform picking work

1. Open the
ReverseReverse
workwork page.

2. On the
request page,
select the
AssignAssign
items toitems to
this locationthis location
option.

The current
work is
canceled.

New work for
the inventory
movement is
created and
closed.

1. Open the
ReverseReverse
workwork page.

2. On the
request page,
select the
Move itemsMove items
to thisto this
locationlocation
option.

1. Open the
ReverseReverse
workwork page.

2. On the
request page,
select the
Move itemsMove items
based onbased on
locationlocation
directivesdirectives
option.
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A work exception of
the Shor t pickShor t pick type
is set up, where ItemItem
reallocationreallocation =
NoneNone, AdjustAdjust
inventor yinventor y  = YesYes ,
and RemoveRemove
reser vationsreser vations = NoNo.

Yes The quantity is re-
reserved for the
same batch. The
system randomly
assigns a location
and license plate (if
the location is license
plate–controlled)
where the quantity is
available.

No See the previous row. Not applicable

A work exception of
the Shor t pickShor t pick type
is set up, where ItemItem
reallocationreallocation =
NoneNone, AdjustAdjust
inventor yinventor y  = YesYes ,
and RemoveRemove
reser vationsreser vations = YesYes .

Yes All existing
reservations that are
affected by the
quantity adjustment
in the short-picked
location are re-
reserved for the
same batch. The
system randomly
assigns a location
and license plate (if
the location is license
plate–controlled)
where the quantity is
available.

No See the previous row. See the previous row. All existing
reservations that are
affected by the
quantity adjustment
in the short-picked
location are removed.

1. Select the
Shor tpickShor tpick
menu item on
the
warehouse
app when you
run picking
work.

2. In the PickPick
QuantityQuantity
field, enter 00
(zero).

3. In the
ReasonReason field,
enter NoNo
reallocationreallocation.

The current
work is
closed, and
the picked
quantity is 0
(zero).

An inventory
transaction of
the
CountingCounting
type and the
SoldSold issue
type is
created to
represent the
adjustment.

The short-
picking action
fails, and an
error is
thrown.

The current
work remains
open.

1. Select the
Shor tpickShor tpick
menu item on
the
warehouse
app when you
run picking
work.

2. In the PickPick
QuantityQuantity
field, enter 00
(zero).

3. In the
ReasonReason field,
enter NoNo
reallocationreallocation.

The current
work is
closed, and
the picked
quantity is 0
(zero).

An inventory
transaction of
the
CountingCounting
type and the
SoldSold issue
type is
created to
represent the
adjustment.



A work exception of
the Shor t pickShor t pick type
is set up, where ItemItem
reallocationreallocation =
ManualManual, AdjustAdjust
inventor yinventor y  = YesYes ,
and RemoveRemove
reser vationsreser vations =
No/YesNo/Yes . Additionally,
the Allow manualAllow manual
item reallocationitem reallocation
option is enabled on
the worker.

Yes Not applicable
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1. Select the
Shor tpickShor tpick
menu item on
the
warehouse
app when you
run picking
work.

2. In the
Shor tpickShor tpick
QuantityQuantity
field, enter 00
(zero).

3. In the
ReasonReason field,
select Shor tShor t
Picking withPicking with
manualmanual
reallocationreallocation.

4. Select the
location/licens
e plate in the
list.

On the
current work,
the following
actions occur:

An inventory
transaction of
the
CountingCounting
type and the
SoldSold issue
type is
created to
represent the
adjustment.

The
pick
line is
closed,
and
the
picked
quanti
ty is 0
(zero).

The
put
line is
cancel
ed.

A new
pick
line is
create
d. It
uses
the
locatio
n/licen
se
plate
that
the
user
selecte
d.

A new
put
line is
create
d.



A work exception of
the Shor t pickShor t pick type
is set up, where ItemItem
reallocationreallocation =
ManualManual, AdjustAdjust
inventor yinventor y  = YesYes ,
and RemoveRemove
reser vationsreser vations = NoNo.
Additionally, the
Allow manual itemAllow manual item
reallocationreallocation option
is enabled on the
worker.

No The short-picking
action fails, and an
error is thrown.

Not applicable

A work exception of
the Shor t pickShor t pick type
is set up, where ItemItem
reallocationreallocation =
ManualManual, AdjustAdjust
inventor yinventor y  = YesYes ,
and RemoveRemove
reser vationsreser vations = YesYes .
Additionally, the
Allow manual itemAllow manual item
reallocationreallocation option
is enabled on the
worker.

No All existing
reservations that are
affected by the
quantity adjustment
in the short-picked
location/license plate
are removed.
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1. Select the
Shor tpickShor tpick
menu item on
the
warehouse
app when you
run picking
work.

2. In the
Shor tpickShor tpick
QuantityQuantity
field, enter 00
(zero).

3. In the
ReasonReason field,
select Shor tShor t
Picking withPicking with
manualmanual
reallocationreallocation.

1. Select the
Shor tpickShor tpick
menu item on
the
warehouse
app when you
run picking
work.

2. In the
Shor tpickShor tpick
QuantityQuantity
field, enter 00
(zero).

3. In the
ReasonReason field,
select Shor tShor t
Picking withPicking with
manualmanual
reallocationreallocation.

4. Select the
location/licens
e plate in the
list.

On the
current work,
the following
actions occur:

An inventory
transaction of
the
CountingCounting
type and the
SoldSold issue
type is
created to
represent the
adjustment.

The
pick
line is
closed,
and
the
picked
quanti
ty is 0
(zero).

The
put
line is
cancel
ed.



A work exception of
the Shor t pickShor t pick type
is set up, where ItemItem
reallocationreallocation =
AutomaticAutomatic, AdjustAdjust
inventor yinventor y  =
Yes/NoYes/No, and
RemoveRemove
reser vationsreser vations =
Yes/NoYes/No.

Not applicable Short-picking that
involves automatic
reallocation isn't
supported.

Short-picking that
involves automatic
reallocation isn't
supported.
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Change the inventory statusChange the inventory status

NOTENOTE
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1. Select the
Shor tpickShor tpick
menu item on
the
warehouse
app when you
run picking
work.

2. In the
Shor tpickShor tpick
QuantityQuantity
field, enter 00
(zero).

3. In the
ReasonReason field,
select Shor tShor t
Picking withPicking with
automaticautomatic
reallocationreallocation.

This warehouse action can be performed from multiple entry points. The example that is shown here uses Inventor yInventor y

status changestatus change action on the On-hand by locationOn-hand by location page.



On the WarehouseWarehouse
tab, in the
WarehouseWarehouse record,
the RemoveRemove
reser vations andreser vations and
markingsmarkings field is set
to Reser vationsReser vations or
Markings andMarkings and
reser vationsreser vations .

Yes Inventory status
changes aren't
allowed for quantities
that are reserved for
work.
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1. Select a
specific
location.

2. Select a line
that has a
specific item,
location, and
license plate
(if the location
is license
plate–
controlled).

3. Select
Inventor yInventor y
statusstatus
changechange.

4. Set the
Inventor yInventor y
statusstatus field
to BlockingBlocking.

The quantity
is re-reserved
for the same
batch. The
system
randomly
assigns a
location and
license plate
(if the location
is license
plate–
controlled)
where the
quantity is
available.

Two inventory
transactions
of the
Inventor yInventor y
statusstatus
changechange type
are created to
represent the
change in the
inventory
status
dimension.

An inventory
transaction of
the
Inventor yInventor y
blockingblocking
type and the
Reser vedReser ved
physicalphysical
issue type is
created to
represent the
reservation of
the blocked
quantity.



No See the previous row. Inventory status
changes aren't
allowed for quantities
that are reserved for
work.

On the WarehouseWarehouse
tab, in the
WarehouseWarehouse record,
the RemoveRemove
reser vations andreser vations and
markingsmarkings field is set
to NoneNone.

Yes Inventory status
changes aren't
allowed for quantities
that are reserved for
work.

The quantity is re-
reserved for the
same batch. The
system randomly
assigns a location
and license plate (if
the location is license
plate–controlled)
where the quantity is
available.

No See the previous row. Inventory status
changes aren't
allowed for quantities
that are reserved for
work.

Inventory status
changes aren't
allowed.
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The
reservation is
removed.

Two inventory
transactions
of the
Inventor yInventor y
statusstatus
changechange type
are created to
represent the
change in the
inventory
status
dimension.

An inventory
transaction of
the
Inventor yInventor y
blockingblocking
type and the
Reser vedReser ved
physicalphysical
issue type is
created to
represent the
reservation of
the blocked
quantity.

1. Select a
specific
location.

2. Select a line
that has a
specific item,
location, and
license plate
(if the location
is license
plate–
controlled).

3. Select
Inventor yInventor y
statusstatus
changechange.

4. Set the
Inventor yInventor y
statusstatus field
to BlockingBlocking.



Limitations

NOTENOTE

The flexible warehouse-level dimension reservation functionality doesn't support the following features:

Catch weight management

Physical negative inventory

Reservation against ordered supply

Transfer orders and raw material picking

The container consolidation rule for packing by directive unit has limitations. For order-committed

reservations, we recommend that you not use container build templates where the Pack by directivePack by directive

unitunit field is enabled. In the current design, location directives aren't used when warehouse work is

created. Therefore, only the lowest unit in the unit sequence group (the inventory unit) is applied during

the containerization wave step.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Troubleshoot reservations in warehouse
management
2/18/2021 • 2 minutes to read • Edit Online

I receive the following error message: "Reservations cannot be
removed because there is work created which relies on the
reservations."
Issue descriptionIssue description

Issue resolutionIssue resolution

I receive the following error message: "Inventory quantity -%1 could
not be updated due to insufficient inventory transactions for item
%2...."
Issue descriptionIssue description

Issue resolutionIssue resolution

I receive the following error message: "Physical on-hand...cannot be
reserved because only 0.00 are available in the inventory."
Issue descriptionIssue description

This topic describes how to fix common issues that you might encounter while you work with warehouse

reservations in Microsoft Dynamics 365 Supply Chain Management.

You can't unreserve inventory on a sales line, because there is open work against the line.

Investigate whether open packing group work exists to bring the item from a packing station to another location

(such as Baydoor). Review the records on the Work creation histor y logWork creation histor y log and Work detailsWork details  pages to

determine what is physically reserving the inventory, and then complete or delete the work to free up the

reservation.

This issue can occur if the system can't update an inventory quantity because there aren't enough inventory

transactions that have the specified dimensions. Here is the full text of the full error message:

Inventory quantity -%1 could not be updated due to insufficient inventory transactions for item %2 with

dimensions Size=%3, Color=%4, Additions=%5, Site=%6, Warehouse=%7, Location=%8, Inventory

status=Available, License plate=%9, Batch number=%10 for reference ID %11 on Lot ID %12.

Make sure that no inventory transactions are physically reserving the quantity. For example, these transactions

might open quality orders, inventory blocking records, or output orders.

This issue can occur if the system can't update an inventory quantity because there aren't enough inventory

transactions that have the specified dimensions. Here is the full text of the full error message:

Physical on-hand Site=%1, Warehouse=%2, Inventory status=Available, Batch number=%3, Owner=%4: %5

cannot be reserved because only 0.00 are available in the inventory.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/troubleshoot-warehouse-reservations.md


Issue resolutionIssue resolution

I receive the following error message: "To be assigned to wave, load
lines must specify the dimensions above the location. To assign these
dimensions, reserve and recreate the load line."
Issue descriptionIssue description

Issue resolutionIssue resolution

NOTENOTE

This issue is probably caused by open work. Either complete the work or receive without work creation. Make

sure that no inventory transactions are physically reserving the quantity. For example, these transactions might

be open quality orders, inventory blocking records, or output orders.

When you use an item that has a "batch above" reservation hierarchy (with the Batch numberBatch number  dimension

placed above the LocationLocation dimension), the Release to warehouseRelease to warehouse command on the Load planningLoad planning

workbenchworkbench page for a partial quantity doesn't work. You receive this error message, and no work is created for

the partial quantity.

However, if you use an item that has a "batch below" reservation hierarchy (with the Batch numberBatch number  dimension

placed below the LocationLocation dimension), you can release a load from the Load planning workbenchLoad planning workbench page for a

partial quantity.

This behavior is by design. If you put a dimension above the LocationLocation dimension in the reservation hierarchy, it

must be specified before the release to the warehouse. Microsoft has evaluated this issue and has determined

that it's a feature limitation during releases to the warehouse from the load planning workbench. Partial

quantities can't be released if one or more dimensions above LocationLocation aren't specified.

For more information, see Flexible warehouse-level dimension reservation policy.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Partial shipment of a transport load
2/18/2021 • 2 minutes to read • Edit Online

NOTENOTE

Set up transport loads for partial shipment

Set the loading strategySet the loading strategy

Create a menu item for loading of transport loadsCreate a menu item for loading of transport loads

By setting up partial shipment of loads, you can handle loads where the capacity can't be determined until all the

sales lines have been added to a load. The process can then be finalized when the exact pallet count is known.

Therefore, you don't have to decide which pallets will be assigned to which transport until the moment when a

transport is being physically loaded out of the staged inventory.

This feature offers an alternative to the enforcement of a more rigid structure, where you must determine which

pallets will be assigned to which transport before picking work or loading work can be created. Instead, users

can configure individual loads for a partial shipment confirmation. The transport loading processes for those

loads can then occur. Therefore, the transportation planning department can plan loads without having to

consider the capacity of individual transports.

At the time of loading, workers can define a new transport load that a pallet can be loaded to. Alternatively, they

can identify an existing transport load. This data can be recorded via a mobile device. Therefore, several

warehouse workers can load inventory from the same loads or different loads onto the same truck. The loads

can then be fully or partially shipped.

In order to load inventory from a load to a specific transport load and partially ship the load, work must be generated by

using a loading class in a work template. Ordinary picking work of the PickingPicking type can't be loaded to a transport load

such as a truck.

The setup for partial shipment of loads consists of the following two procedures.

You must enable partial loading by setting the loading strategy. You can set the loading strategy after you've

created a load.

1. Select Warehouse managementWarehouse management > LoadsLoads  > All loadsAll loads .

2. Select a load, and then click HeaderHeader .

3. In the Loading strategyLoading strategy  field, select Par tial load shipping allowedPar tial load shipping allowed.

You must create a new menu item that enables transport loads to be loaded. A transport load lets you group

work lines from one load or multiple loads. Everything that is added to the transport load can then be shipped

by using a mobile scanner.

1. Select Warehouse managementWarehouse management > SetupSetup > Mobile deviceMobile device > Mobile device menu itemsMobile device menu items .

2. Select NewNew , and then, in the ModeMode field, select WorkWork .

3. Set the Use existing workUse existing work option to YesYes .

4. On the GeneralGeneral  tab, in the Directed byDirected by  field, select Transpor t loadingTranspor t loading.

5. To enable shipment confirmation on a mobile scanner, in the Allowed ship confirmation typeAllowed ship confirmation type field, select

Transpor t loadTranspor t load.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/partial-shipping-of-transport-loads.md


Confirm shipment of a transport load from the client

NOTENOTE

This setup lets you confirm a transport load that includes a full load or a partially loaded load to be shipped.

1. Select Warehouse managementWarehouse management > LoadsLoads  > Transpor t loadsTranspor t loads .

2. On the Action Pane, on the Ship and receiveShip and receive tab, in the ConfirmConfirm group, select Transpor tTranspor t.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Batch release of partially reserved transfer orders
2/18/2021 • 2 minutes to read • Edit Online

Where it applies

How it is set up
Specify fulfillment criteria for transfer orders and sales ordersSpecify fulfillment criteria for transfer orders and sales orders

Set the fulfillment policies for transfer orders and sales ordersSet the fulfillment policies for transfer orders and sales orders

Allow release in a batch and specify the quantity that should be
release in a batch

The functionality for batch release of partially reserved transfer orders lets you partially release transfer orders

to a warehouse by using a batch job. Because you have the option to release a partial quantity, you don’t have to

wait for the whole order quantity to be available in the warehouse before you release an order.

The release of orders to a warehouse is an advanced warehouse management process. This process involves

activities, such as picking, packing, and shipping, that a warehouse worker can perform by using a mobile

device.

For this functionality, transfer orders are released to a warehouse by using a batch job. This functionality is

useful when you don’t have enough inventory in the warehouse, but you still want to transfer items from one

warehouse to another.

Before an order can be partially released to a warehouse in a batch, the fulfillment criteria must be met. These

fulfillment criteria are determined by the fulfillment policy.

Fulfillment policies for transfer orders and sales orders are specified at the company level. Depending on the

setup of the fulfillment policy, the release of orders in a batch will be accepted or rejected. The orders will then

be processed accordingly.

To create fulfillment policies for transfer orders and sales orders, click Warehouse managementWarehouse management >

SetupSetup > Release to warehouseRelease to warehouse > Fulfillment policyFulfillment policy , and then create a fulfillment policy by entering

a name and a description.

To specify a fulfillment rate, a value type, and the message that is shown if the fulfillment policy is

violated, click Warehouse managementWarehouse management > SetupSetup > Release to warehouseRelease to warehouse > Fulfillment policyFulfillment policy ,

and then set the Fulfil lment rateFulfillment rate, Value typeValue type, and Fulfillment violation messageFulfillment violation message fields.

To set the fulfillment policies for transfer orders, click Inventor y managementInventor y management > SetupSetup > Inventor yInventor y

and warehouse management parametersand warehouse management parameters  > Transfer ordersTransfer orders  > Warehouse managementWarehouse management, and

then select a transfer order fulfillment policy.

To set the fulfillment policies for sales orders, click Accounts receivableAccounts receivable > SetupSetup > AccountsAccounts

receivable parametersreceivable parameters  > Warehouse managementWarehouse management, and then select a sales order fulfillment policy.

A batch job is used to release orders to a warehouse in a batch. The parameters that distinguish the orders that

should be run in a batch job are set on the batch job itself.

The QuantityQuantity  parameter specifies whether the whole quantity or the physically reserved quantity should be

released in the batch. The Allow release of par tially released ordersAllow release of par tially released orders  parameter determines whether orders

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/batch-release-of-partially-reserved-transfer-orders.md


NOTENOTE

in the batch should be accepted or rejected if they were partially released earlier.

To set the QuantityQuantity  and Allow release of par tially released ordersAllow release of par tially released orders  parameters for transfer orders,

click Warehouse managementWarehouse management > Release to warehouseRelease to warehouse > Automatic release of transfer ordersAutomatic release of transfer orders .

To set the QuantityQuantity  and Allow release of par tially released ordersAllow release of par tially released orders  parameters for sales orders, click

Warehouse managementWarehouse management > Release to warehouseRelease to warehouse > Automatic release of sales ordersAutomatic release of sales orders .

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Troubleshoot partial releases and partial shipments
2/18/2021 • 2 minutes to read • Edit Online

The release status of a sales order remains Partially released even
after the sales order is invoiced.
Issue descriptionIssue description

Issue resolutionIssue resolution

NOTENOTE

This topic describes how to fix common issues that you might encounter while you work with partial releases

and partial shipments in Microsoft Dynamics 365 Supply Chain Management.

A sales order is a delivery order, but one or more items on it have a different mode of delivery. After the order is

invoiced, it still has a release status of Partially released.

For example, a sales order has two items: one for delivery and one for pickup. Both the delivery and the pickup

have been done. Therefore, both lines have been invoiced. However, the release status is still shown as Partially

released, which is misleading.

The release status applies only to order lines where the items are enabled for warehouse management.

Therefore, the release status remains Partially released in this scenario. Microsoft has evaluated this issue and

has determined that it's a feature limitation. An extension could be added as part of the packing slip and

invoicing process to update the release status.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/troubleshoot-warehouse-partial-release-shipment.md
https://aka.ms/BAG_Docs_Language_Survey
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Set up cluster picking
2/18/2021 • 3 minutes to read • Edit Online

About cluster picking

Enable cluster picking

Set up a cluster profile

This topic describes how to enable workers to use their mobile devices to group picking work into clusters, so

that they can pick items from a single location for multiple work orders at the same time. This is called cluster

picking.

After work orders are released to the warehouse, the worker can use a mobile device to assign the orders to a

cluster. The cluster will organize the picking work for the worker. When a work order is assigned to a cluster, the

worker must use cluster picking to perform the picking work for the order. The worker cannot use other picking

methods. If a work order is assigned to a cluster by mistake, the worker must break the cluster and then re-

create it.

If needed, a worker can pass a cluster to another worker. This changes the cluster status to Passed. When the

worker uses a mobile device to indicate that the picking and put away work is completed, the shipment or load

must be confirmed in the client.

To enable cluster picking, you must set up the following:

Cluster profilesCluster profiles  – Specify whether to automatically generate cluster IDs, the number of positions to use,

when to break clusters, and how to sequence and verify the picking work.

Work templatesWork templates  – Define how to create the picking work for cluster picking.

Location directivesLocation directives  – Specify where to pick items from, and where to put them.

Mobile device menu itemsMobile device menu items – Configure a mobile device menu item to use existing work that is

directed by cluster picking. You must then add the menu item to a mobile device menu so that it is

displayed on mobile devices.

Warehouse management parametersWarehouse management parameters  – Specify the number sequence to use if you want to generate

identifiers for clusters.

To set up a cluster profile, follow these steps:

1. Click Warehouse managementWarehouse management > SetupSetup > Mobile deviceMobile device > Cluster profilesCluster profiles .

2. Click NewNew  to create a new profile.

3. Click Create clusterCreate cluster  and, under Cluster sor tingCluster sor ting, click NewNew  to set up the sorting criteria for the cluster.

The sorting criteria control the order in which the worker will perform the picking work. You can add as

many criteria as needed.

4. In the Sequence numberSequence number  field, enter a number to define the order in which the sorting criteria are

processed.

5. In the Field nameField name field, select the field that will determine the sorting. For example, if you select the

WMSLocationIdWMSLocationId field, the work will be sorted by location.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/set-up-cluster-picking.md
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AscendingAscending Picking work is sequenced in ascending order based on the
sorting criteria. For example, if you use the
WMSLocationIdWMSLocationId field as sorting criteria, and your location
IDs are 1, 2, 3, and 4, you will pick from location 4 first.

DescendingDescending Picking work is sequenced in descending order based on the
sorting criteria. For example, if you use the
WMSLocationIdWMSLocationId field as sorting criteria, and your location
IDs are 1, 2, 3, and 4, you will pick from location 1 first.

Item confirmation

Set up item verification with cluster pickingSet up item verification with cluster picking

NOTENOTE

6. In the Sor tingSor ting field, select one of the following options.

When cluster picking is applied, item confirmation is crucial to verify the items that are added to clusters. You

can verify items in cluster picking during the cluster picking process. The setup is based on the product bar code

setup.

1. On a mobile device menu item, open the setup form for work confirmation: Warehouse managementWarehouse management

> Warehouse managementWarehouse management > SetupSetup > Mobile deviceMobile device > Mobile device menu itemsMobile device menu items .

2. From the mobile device menu item, open Work confirmation setupWork confirmation setup. The Product confirmationProduct confirmation

option allows you to verify each piece of inventory from the mobile device when scanned.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Turn on the Cluster position full feature

Setup

Make sample data availableMake sample data available

Cluster profilesCluster profiles

The Cluster position full feature offers an alternative to more rigid enforcement of work break rules when

cluster picking is used, because it enables a larger margin of error in the volumetric constraints of containers or

totes. In a common scenario, not all items on a work order fit into a selected container. Warehouse workers who

are cluster picking have few options in this scenario: they must either change to a larger container size or work

with their supervisor to come up with a different solution.

This feature introduces the ability to run the FullFull  button on one of the work units in a cluster. In older versions,

this option was available only for regular order picking, not for cluster picking. However, this feature differs from

the standard FullFull  button in that it cancels the remaining work. It doesn't suggest that the user add another bin

to the same cluster, and it doesn't automatically create new work.

Before you can use this feature, it must be turned on in your system. Admins can use the feature management

settings to check the status of the feature and turn it on. In the Feature managementFeature management workspace, the feature is

listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Cluster position full

This section provides guidelines, and an example that shows how to set up and use the Cluster position full

feature.

To work through the example scenario by using the sample records and values that are specified here, you must

be on a system where the standard demo data is installed. Additionally, you must select the USMFUSMF legal entity

before you begin.

You can also use the example scenario as guidance for working with this feature on a production system.

However, in that case, you must substitute your own values for the settings that are described here.

You must specify whether cluster IDs are automatically generated, how many positions are used, when clusters

are broken, and how the picking work is sequenced and verified.

1. Go to Warehouse management > Setup > Mobile device > Cluster profilesWarehouse management > Setup > Mobile device > Cluster profiles .

2. In the list pane, select the Create ClusterCreate Cluster  record.

3. On the GeneralGeneral  FastTab, verify the following values:

Generate cluster ID:Generate cluster ID: Yes

Activate positions:Activate positions: Yes

Number of positions:Number of positions: 2

Position name:Position name: Numeric

Break cluster at:Break cluster at: Put

Sor t ver ification type:Sor t ver ification type: Position scan

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/cluster-position-full.md


Work templatesWork templates

Location directivesLocation directives

Mobile device menu itemsMobile device menu items

4. In the Cluster sor tingCluster sor ting FastTab. The grid should be blank (that is, it should contain no lines).

You must define how the picking work for cluster picking is created.

1. Go to Warehouse management > Setup > Work > Work templatesWarehouse management > Setup > Work > Work templates .

2. At the top of the page, set the Work order typeWork order type field to Sales orders.

3. Make sure that the following work templates from the demo data are listed. If they aren't available, you

won't be able to complete the scenario.

61 SO Stage

61 SO Cluster pick

You must specify where items are picked from and where they are put.

1. Go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives .

2. In the list header, set the Work order typeWork order type field to Sales orders.

3. Make sure that the following sales order directives from the demo data are listed. If they aren't available,

you won't be able to complete the scenario.

61 Cluster pick

61 SO Pick order

You must configure a mobile device menu item to use existing work that is directed by cluster picking. In the

mobile device menu item for cluster picking, the Allow splitting of workAllow splitting of work parameter must be turned on, and

the SO Pick work class must be added.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. In the list pane, select the Cluster Pick CreateCluster Pick Create record.

3. Select EditEdit in the Action pane.

4. On the GeneralGeneral  FastTab, set the following values:

Directed by:Directed by: Cluster picking

Generate license plate:Generate license plate: Yes

Allow splitting of work :Allow splitting of work : Yes

Cluster profile ID:Cluster profile ID: Create Cluster

Accept the default values for all other fields.

5. On the Work classesWork classes  FastTab, add the following two lines, as required:

Line 1 (usually present in demo data):

Work class ID:Work class ID: Sales

Work order type:Work order type: Sales orders

Line 2 (probably not present in demo data):

Work class ID:Work class ID: SO Pick

Work order type:Work order type: Sales orders

6. Go to Work confirmation setupWork confirmation setup in the Action pane.



Create picking work

Create sales order 1Create sales order 1

Create sales order 2Create sales order 2

7. Select EditEdit.

8. Enter the following values on the line in grid.

Work typeWork type - Pick

Product confirmationProduct confirmation - Select the check box

9. Select SaveSave in the Action pane and close the page.

Before you can start cluster picking, you must create some outbound work. The cluster profile that you created

earlier specifies two cluster positions. Therefore, at least two work IDs must be created for sales order picking.

For this scenario, transactions will occur in warehouse 61, and they will use items L0101 and T0100. The demo

data should have enough on-hand inventory of these items. Make sure that you have enough inventory to

complete the transactions.

1. Go to Sales and Marketing > Sales orders > All sales ordersSales and Marketing > Sales orders > All sales orders .

2. Select NewNew  to create sales order 1.

3. In the Create sales orderCreate sales order  dialog box, set the following values:

Customer account:Customer account: US-010

Warehouse:Warehouse: 61

4. Select OKOK.

5. The new sales order is opened. On the Sales order linesSales order lines  FastTab, add a line that has the following

settings:

Item number :Item number : T0100

Quantity:Quantity: 5

6. On the L ine detailsL ine details  FastTab, on the Deliver yDeliver y  tab, set the Confirmed ship dateConfirmed ship date field to today's date.

7. On the Sales order linesSales order lines  FastTab, add a second line that has the following settings:

Item number :Item number : L0101

Quantity:Quantity: 20

8. On the L ine detailsL ine details  FastTab, on the Deliver yDeliver y  tab, set the Confirmed ship dateConfirmed ship date field to today's date.

9. For each line that you just added, follow these steps to reserve inventory:

a. Select the line to reserve.

b. On the Sales order linesSales order lines  FastTab, select Inventor y > Reser vationInventor y > Reser vation.

c. On the Reser vationReser vation page, on the Action Pane, select Reser ve lotReser ve lot to reserve the inventory.

d. Close the Reser vationReser vation page.

10. On the Action Pane, on the WarehouseWarehouse tab, select Release to warehouseRelease to warehouse.

When the release is completed, you receive informational messages that show the wave and load IDs that

were created.

1. Go to Sales and Marketing > Sales orders > All sales ordersSales and Marketing > Sales orders > All sales orders .

2. Select NewNew  to create sales order 2.

3. In the Create sales orderCreate sales order  dialog box, set the following values:
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Customer account:Customer account: US-011

Warehouse:Warehouse: 61

4. Select OKOK.

5. The new sales order is opened. On the Sales order linesSales order lines  FastTab, add a line that has the following

settings:

Item number :Item number : L0101

Quantity:Quantity: 20

6. On the L ine detailsL ine details  FastTab, on the Deliver yDeliver y  tab, set the Confirmed ship dateConfirmed ship date field to today's date.

7. On the Sales order linesSales order lines  FastTab, add a second line that has the following settings:

Item number :Item number : T0100

Quantity:Quantity: 2

8. On the L ine detailsL ine details  FastTab, on the Deliver yDeliver y  tab, set the Confirmed ship dateConfirmed ship date field to today's date.

9. For each line that you just added, follow these steps to reserve inventory:

a. Select the line to reserve.

b. On the Sales order linesSales order lines  FastTab, select Inventor y > Reser vationInventor y > Reser vation.

c. On the Reser vationReser vation page, on the Action Pane, select Reser ve lotReser ve lot to reserve the inventory.

d. Close the Reser vationReser vation page.

10. On the Action Pane, on the WarehouseWarehouse tab, select Release to warehouseRelease to warehouse.

When the release is completed, you receive informational messages that show the wave and load IDs that

were created.

Two work IDs should have been created, each of which has two pick lines. Follow these steps to find the work

IDs and license plate assignments.

1. Go to Warehouse management > Work > Work detailsWarehouse management > Work > Work details .

2. In the Over viewOver view  grid, search the Order numberOrder number  column for the two sales orders that you just created.

For each sales order, make a note of the corresponding work ID.

3. Select the row for each sales order to show related information in the L inesLines  grid. Make a note of the

location that each item will be picked from.

4. Go to Inventor y management > Inquir ies and repor ts > On-hand listInventor y management > Inquir ies and repor ts > On-hand list.

5. On the Action Pane, select DimensionsDimensions  to open the Dimension displayDimension display  dialog box.

6. Make sure that the L icense plateLicense plate, WarehouseWarehouse, and Item numberItem number  check boxes are selected, and then

select OKOK.

7. In the FilterFilter  pane, set the following filters:

Item numberItem number  – is one ofis one of  – L0101 and T100

WarehouseWarehouse – begins withbegins with – 61

8. Make a note of the L icense plateLicense plate values that are shown.

1. Sign in to the warehouse app as a user in warehouse 61.



2. Go to Outbound > Cluster pick createOutbound > Cluster pick create.

The TASK: Assign work to ClusterTASK: Assign work to Cluster  page appears.

3. Enter the work ID for sales order 1 to assign it to cluster position 1.

4. Select OKOK (check mark symbol).

5. Enter the work ID for sales order 2 to assign it to cluster position 2.

6. Select OKOK (check mark symbol).

The TASK: Cluster Pick Create: PickTASK: Cluster Pick Create: Pick  page appears and shows Item L0101 2 PL.

Because the cluster profile set the number of positions to 2, the system automatically directs you to the first

consolidate pick: two pallets (PL) of item L0101.

At any time during the following steps, you can select the DetailsDetails  tab to view additional information about the

task, such as the picking location.

1. Set the ITEMITEM field to L0101. This confirms the item number, which is required for this menu item (you

configured this earlier by selecting Work confirmation setupWork confirmation setup from the Mobile device menu itemMobile device menu item

page when you created this menu item).

2. Enter the license plate number that is associated with the item in the location that is being picked. You will

pick two pallets.

3. Set the LPLP field to LP_PICK_01.

4. Select OKOK (check mark symbol).

The TASK: Sor t: Cluster Pick CreateTASK: Sor t: Cluster Pick Create page appears. Here, you will sort the two picked pallets into a pick

position. This position might be a tote or container that is used to separate the picked inventory by sales

order.

5. View the details that are shown for the item (L0101) and quantity (20 ea) that will be sorted into position

1 (for sales order 1).

6. Set the POSITION NAPOSITION NA field to 1.

7. Select OKOK (check mark symbol).

8. View the details that are shown for the item (L0101) and quantity (20 ea) that will be sorted into position

2 (for sales order 2).

9. Set the POSITION NAPOSITION NA field to 2.

10. Select OKOK (check mark symbol).

The TASK: Cluster Pick Create: PickTASK: Cluster Pick Create: Pick  page appears and shows Item T0100 7 ea.

In this scenario, position 1 can't accept the full quantity of items that must be picked to fulfill sales order 1. A

position must be marked as full. In this scenario, you will do a partial pick of the second item. The second item

will be partially picked for position 1, and new work will be created to pick the remaining quantity to fulfill the

order.

1. Select the Menu button (sometimes referred to as the hamburger or the hamburger button), and then

select Position fullPosition full .

2. Identify the position that is full, and select 1.

3. Select OKOK (check mark symbol).
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4. Enter the pick quantity that can still be picked into position 1. The system can determine which item

number is being picked.

5. Enter 2.

6. Select OKOK (check mark symbol).

7. Confirm the item number to complete the pick of the remaining item into position 2.

8. Set the ITEMITEM field to T0100.

9. Select OKOK (check mark symbol).

10. Enter the license plate that the item is being picked from by setting the LPLP field to LPREPL04.

11. Select OKOK (check mark symbol).

12. View the details that are shown for the item (T0100) and quantity (2 ea) that will be sorted into position 2

(for sales order 2).

13. Set the POSITION NAPOSITION NA field to 2.

14. Select OKOK (check mark symbol).

15. View the details that are shown for the item (T0100) and quantity (2 ea) that will be sorted into position 1

(for sales order 1).

16. Set the POSITION NAPOSITION NA field to 1.

17. Select OKOK (check mark symbol).

The TASK: Cluster Pick Create: PutTASK: Cluster Pick Create: Put page appears.

In this scenario, the cluster pick has been completed, and the user is directed to put away the picked items from

position 1 and position 2 into staging location STAGE01.

1. Review the information on the page. It shows that a total quantity of 44 will be put to the staging location.

2. Select OKOK (check mark symbol).

You receive a "Cluster Completed" message.

You can now use the Sales PickingSales Picking menu item to pick the remaining quantity. You can then use the SalesSales

loadingloading menu item to move the items from the staging location to the loading dock.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Enable the System-directed cluster picking feature

Set up system-directed cluster picking
Create cluster profilesCreate cluster profiles

Cluster picking is a piece picking process that lets you pick items for multiple orders at the same time by

clustering them into pick clusters. You then have to visit the pick location only one time. Typically, this

functionality is used with small order picking or quantities that are less than case quantities.

When system-directed cluster picking is set up, you can cluster-pick work headers, based on a system-generated

cluster. The system cluster-picks orders up to the number of positions that is specified in the cluster profile.

Therefore, you can pick multiple orders at the same time without having to manually create a cluster.

System-directed cluster picking offers an alternative to manual cluster building, where a cluster profile is used to

create a cluster. Several setup-related lines must be defined in the cluster profile before it's used:

Number of positionsNumber of positions  corresponds to the number of orders that will be put on a cluster. Therefore, it

corresponds to the number of totes.

Break clusterBreak cluster  determines when the cluster should be broken.

Generate cluster IDGenerate cluster ID controls whether the cluster ID will be generated by the system or entered by the user.

Sor t ver ification typeSor t ver ification type determines whether position verification is required.

A new mobile device menu item is used for system-directed cluster picking. The Cluster profile IDCluster profile ID must be

specified for the selected Directed byDirected by  option. Additionally, the system-directed work sequence queries can

group orders based on company-specific criteria. Therefore, you can further optimize the assignment of work

orders by specifying customized sorting criteria using the system-directed work sequence queries.

When system-directed cluster picking is enabled, warehouse workers are presented with a cluster where picking

orders have been preassigned to cluster positions. Therefore, workers can start to pick an item for multiple work

orders by visiting the pick location only one time. The picking process for system-directed cluster picking is the

same as the process for user-directed cluster picking.

Before you can use this feature, it must be enabled on your system. Administrators can use the feature

management page to check the feature status and enable it if needed. Here, the feature is listed as:

ModuleModule - Warehouse management

Feature nameFeature name - System directed cluster picking

This feature also requires enabling a dependent feature. The dependent feature is:

ModuleModule - Warehouse management

Feature nameFeature name - Organization-wide system directed work sequencing

Cluster profiles control how the system creates each cluster. If different clusters are required, a different cluster

profile should be created for each mobile device menu item.

1. Go to Warehouse management > Setup > Mobile device > Cluster profilesWarehouse management > Setup > Mobile device > Cluster profiles .

2. Select NewNew .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/system-directed-cluster-pick.md
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3. In the Cluster profile IDCluster profile ID field, enter 2 Position2 Position.

4. In the NameName field, enter 2 Position2 Position.

5. On the GeneralGeneral  FastTab, enter the following information:

Generate cluster IDGenerate cluster ID - Select YesYes . This option determines whether the cluster ID is automatically

created by the system, or whether the user will create it at the start of picking.

Activate positionsActivate positions  - Select YesYes . This option determines whether the position names are

automatically generated based on the position name setup. If this option is set to NoNo, the license plate

ID for the position is used.

Number of positionsNumber of positions  - Select 22 . This field determines the maximum number of positions that the

cluster can have (that is, the maximum number of boxes, totes, and so on).

Position namePosition name - Select NumericNumeric so that positions are named by using continuous numbers. If you

select AlphabeticalAlphabetical , the positions are named in alphabetical order.

Break cluster atBreak cluster at - Select PutPut. This field determines when the cluster is broken.

Sor t ver ification typeSor t ver ification type - Select Position scanPosition scan. This field determines whether the put-to-position

step is verified.

6. On the Cluster sor tingCluster sor ting FastTab, you define sorting criteria by creating a new line and enter the

following information:

Sequence numberSequence number  - Select 11 . This field determines the sequence that the system sorts by. A value is

entered automatically, but you can change it if needed.

Field nameField name - Enter WMSLocationIdWMSLocationId. This field determines the field that the line uses for sorting

criteria.

Sor tingSor ting - Select AscendingAscending. This field defines whether the sorting is done in ascending or

descending order.

To create a new mobile device menu item for system-directed cluster picking and link the cluster profile ID to the

mobile device menu item, follow these steps.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. Select NewNew .

3. In the header section, enter the following information:

Menu item nameMenu item name - SD Cluster

TitleTitle - SD Cluster

ModeMode - Work

Use existing workUse existing work - Yes

4. On the GeneralGeneral  FastTab, enter the following information:

Directed byDirected by  - System directed cluster picking

Generate license plateGenerate license plate - Yes

Cluster profile IDCluster profile ID - 2 Position

5. On the Work classesWork classes  FastTab, set up the valid work class for this mobile device menu item by setting the

following fields:

Work class IDWork class ID - Sales

Work order typeWork order type - Sales orders

6. In the Mobile device menu itemsMobile device menu items Action Pane, select System directed work sequence queriesSystem directed work sequence queries  and

follow these steps to specify a new system-directed work sequence query:



Set up a mobile device menuSet up a mobile device menu

Scenario
Create picking workCreate picking work

Select NewNew  in the Action Pane.

Sequence numberSequence number  - 1

Descr iptionDescr iption - Work priority – Work ID

7. On the Action Pane select Edit quer yEdit quer y

8. Select the Sor tingSor ting tab

9. Select AddAdd to add a new line, then enter the following:

TableTable - Work

Derived tableDerived table - Work

FieldField - Work priority

Search directionSearch direction - Ascending

10. Select AddAdd to add a second line, then enter the following:

TableTable - Work

Derived tableDerived table - Work

FieldField - Work ID

Search directionSearch direction - Ascending

11. The system will now sort work IDs in the cluster, first by work priority and then by work ID.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menuWarehouse management > Setup > Mobile device > Mobile device menu.

2. Add the SD ClusterSD Cluster  menu item that you just created to a Mobile device menu.

3. Select the OutboundOutbound menu.

4. Select EditEdit from the Action Pane.

5. Scroll until you find SD ClusterSD Cluster .

6. Select SD ClusterSD Cluster , the arrow pointing to the Menu StructureMenu Structure list will be enabled.

7. Select the arrowarrow  button to move the SD ClusterSD Cluster  menu item into the OutboundOutbound menu structure.

8. Select SD ClusterSD Cluster  from the Menu StructureMenu Structure list, then select the UPUP or DOWNDOWN arrows to move the menu

item into the desired position on the mobile device menu.

Before you can set up system-directed cluster picking, you must create eligible outbound work. The cluster

profile that you created earlier specifies two cluster positions. Therefore, you must create at least two work IDs.

In this scenario you will create two sales orders, reserve inventory, release the sales orders to the warehouse,

and then manually process the wave.

1. Go to Sales and Marketing > Sales orders > All sales ordersSales and Marketing > Sales orders > All sales orders .

2. Select NewNew  in the Action Pane to create the first sales order.

The Create sales orderCreate sales order  menu opens, enter the following information:

On the Sales order linesSales order lines  FastTab, select Add lineAdd line if a new line is not automatically added and enter

the following:

On the CustomerCustomer  FastTab, enter Customer accountCustomer account - US-004US-004 .

On the GeneralGeneral  FastTab, enter WarehouseWarehouse - 6262 .

Select OKOK to close the menu and create the sales order.

Item numberItem number  - A0001

QuantityQuantity  - 1

Select Add lineAdd line to add a second line.
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3. Select NewNew  in the Action Pane to create the second sales order

4. Find the two sales orders you just created (you may need to refresh the page). In the table, select both sales

orders using the section check mark.

5. When the release to warehouse process is completed, an informational message will be displayed.

6. Go to Warehouse management > Outbound waves > Shipment waves > All wavesWarehouse management > Outbound waves > Shipment waves > All waves .

7. OptionalOptional : Go to Warehouse management > Work > Work detailsWarehouse management > Work > Work details  to view the work created. Two

different work IDs are created. Each work ID has two pick lines.

Reserve inventory for both of the lines that you just created.

Item numberItem number  - A0002

QuantityQuantity  - 3

Select L ine 1Line 1 .

On the Sales order linesSales order lines  Action Pane, select Inventor yInventor y , and then select Reser vationReser vation from

the list.

On the Reser vationReser vation form, select Reser ve lotReser ve lot to reserve the inventory.

Close the Reser vationReser vation form when the reservation is completed.

Repeat these steps to reserve inventory for L ine 2Line 2 .

The Create sales orderCreate sales order  menu opens, enter the following information:

On the Sales order linesSales order lines  FastTab, select Add lineAdd line if a new line is not automatically added and enter

the following information:

Reserve inventory for both lines that you just created.

Close the sales order and return to the All sales ordersAll sales orders  list page.

On the CustomerCustomer  FastTab, enter Customer accountCustomer account - US-005US-005 .

On the GeneralGeneral  FastTab, enter WarehouseWarehouse - 6262 .

Select OKOK to close the menu and create the sales order

Item numberItem number  - A0001

QuantityQuantity  - 4

Select Add lineAdd line to add a second line.

Item numberItem number  - A0002

QuantityQuantity  - 2

Select L ine 1Line 1 .

On the Sales order linesSales order lines  Action Pane, select Inventor yInventor y , and then select Reser vationReser vation from

the list.

On the Reser vationReser vation form, select Reser ve lotReser ve lot to reserve the inventory.

Close the Reser vationReser vation form when the reservation is completed.

Repeat these steps to reserve inventory for L ine 2Line 2 .

In the All sales ordersAll sales orders  Action Pane, select the WarehouseWarehouse tab.

In the ActionsActions  group, select Release to warehouseRelease to warehouse to release both sales orders to the warehouse.

Shipments will be created for each sales order.

A wave will be created and both shipments will be assigned to the wave. Make note of the Wave IDWave ID.

In the All wavesAll waves  list find and select the Wave IDWave ID that you created in the previous step.

In the Action Pane, select the WaveWave tab,

In the WaveWave group, select ProcessProcess  to process the wave and create WorkWork .

Informational messages will be generated when processing has been completed, indicating that work

has been created and the wave has been posted.

1. Sign in to the mobile device for a user in warehouse 6262 .
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2. On the Main MenuMain Menu, select OutboundOutbound.

3. On the OutboundOutbound menu, select SD ClusterSD Cluster  to initiate the pick.

A cluster is created, and the two work IDs that you created earlier are attached. If you created more

than two work IDs, only the first two are added to the cluster. Notice that the work IDs are added to the

cluster in ascending order, as you specified in the query setup.

The new cluster is automatically created only if enough additional work IDs were previously created. Otherwise,

the following message is shown: "Not enough work can be found for cluster."

After you select the menu, the first pick screen appears. The system aggregates all matching pick lines

from the two work IDs and directs you to visit the pick location one time, so that you can satisfy both

orders by using one pick. This process is done in the same way as the process for user-directed cluster

picking.

4. Confirm the first picking location and item by selecting OKOK.

The quantity of the pick will be the total of the item displayed on the sales orders in the cluster.

5. Enter the position name (Numeric or Alphabetical) to confirm that the item quantity picked for the

position were put in the correct position.

6. Repeat this process until all item quantities have been picked and put in the correct position.

7. The last step on the mobile device is to PutPut the cluster in the final location. Select OKOK

When the put operation is confirmed, the cluster is closed and broken, based on the value that you set

for the Break cluster atBreak cluster at field in the cluster profile. Work IDs are also closed.

8. A "Cluster complete" message is shown on the mobile device.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Turn on the packaging product dimensions feature

Example scenario
Set up the scenarioSet up the scenario

Enable demo dataEnable demo data

Add a new physical dimension to a productAdd a new physical dimension to a product

Some items are packed or stored in such a way that you may need to track physical dimensions differently for

each of several different processes. The Packaging product dimensions feature lets you set up one or several

types of dimensions for each product. Each dimension type provides a set of physical measurements (weight,

width, depth, and height), and establishes the process where those physical measurement values apply. When

this feature is enabled, your system will support the following types of dimensions:

Storage - Storage dimensions are used along with location volumetrics to determine how many of each item

can be stored in various warehouse locations.

Packing - Packing dimensions are used during containerization and the manual packing process to determine

how many of each item will fit in various container types.

Nested packing - Nested packing dimensions are used when the packing process contains multiple levels.

Storage dimensions are supported even when the Packaging product dimensions feature isn't enabled. You set

these up using the Physical dimensionPhysical dimension page in Supply Chain Management. These dimensions are used by all

processes where the packing and nested packing dimensions aren't specified.

Packing and nested packing dimensions are set up using the Physical product dimensionsPhysical product dimensions  page, which is

added when you enable the Packaging product dimensions feature. This topic provides a scenario that illustrates

how to use this feature.

Before you can use this feature, it must be turned on in your system. Admins can use the Feature management

workspace to check the status of the feature and turn it on if it's required. There, the feature is listed in the

following way:

Module:Module: Warehouse management

Feature name:Feature name: Packaging product dimensions

Before you can run the example scenario, you must prepare your system as described in this section.

To work through this scenario using the demo records and values that are specified here, you must be on a

system where the standard demo data is installed. Additionally, you must select the USMF legal entity before

you begin.

Add a new physical dimension for a product by doing the following:

1. Go to Product information management > Products > Released productsProduct information management > Products > Released products .

2. Select the product with Item numberItem number  A0001.

3. On the Action Pane, open the Manage inventor yManage inventor y  tab and, from the WarehouseWarehouse group, select PhysicalPhysical

product dimensionsproduct dimensions .

4. The Physical product dimensionsPhysical product dimensions  page opens. On the Action Pane, select NewNew  to add a new dimension to

the grid with the following settings:

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/packing-vs-storage-dimensions.md


Create a new container typeCreate a new container type

Create a container groupCreate a container group

Set up a container build templateSet up a container build template

Run the scenarioRun the scenario

Create a sales order and create a shipmentCreate a sales order and create a shipment

Physical dimension typePhysical dimension type - Packing

Physical unitPhysical unit - pcs

WeightWeight - 4

Weight unitWeight unit - kg

DepthDepth - 3

HeightHeight - 4

WidthWidth - 3

LengthLength - cm

Volume unitVolume unit - cm3

The VolumeVolume field is automatically calculated based on your DepthDepth, HeightHeight, and WidthWidth settings.

Go to Warehouse management > Setup > Containers > Container typesWarehouse management > Setup > Containers > Container types  and create a new record with

the following settings:

Container type codeContainer type code - Short Box

Descr iptionDescr iption - Short Box

Maximum net weightMaximum net weight - 50

VolumeVolume - 144

LengthLength - 6

WidthWidth - 6

HeightHeight - 4

Go to Warehouse management > Setup > Containers > Container groupsWarehouse management > Setup > Containers > Container groups  and create a new record with

the following settings:

Container group IDContainer group ID - Short Box

Descr iptionDescr iption - Short Box

Add a new line to the DetailsDetails  section. Set the Container typeContainer type to Short Box.

Go to Warehouse management > Setup > Containers > Container build templatesWarehouse management > Setup > Containers > Container build templates  and select BoxesBoxes .

Change the Container group IDContainer group ID to Short Box.

After you have prepared your system as described in the previous section, you are ready to run the scenario as

described in the next section.

In this process you will create a shipment based on the item packing dimensions, for which the height is less

than 3.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. On the Action Pane, select NewNew .

3. In the Create sales orderCreate sales order  dialog box, set the following values:

Customer account:Customer account: US-001

Warehouse:Warehouse: 63

4. Select OKOK to create the sales order and close the dialog box.

5. The new sales order is opened. It should include a new, empty line in the grid on the Sales order linesSales order lines



Place an item into storagePlace an item into storage
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FastTab. On this line, set the following values:

Item number :Item number : A0001

Quantity:Quantity: 5

6. On the Sales order linesSales order lines  FastTab, select Inventor y > Reser vationInventor y > Reser vation.

7. On the Reser vationReser vation page, on the Action Pane, select Reser ve lotReser ve lot to reserve the inventory.

8. Close the page.

9. On the Action Pane, open the WarehouseWarehouse tab and select Release to warehouseRelease to warehouse to create work for the

warehouse.

10. On the Sales order linesSales order lines  FastTab, select Warehouse > Shipment detailsWarehouse > Shipment details .

11. On the Action Pane, open the Transpor tationTranspor tation tab and select View containersView containers . Confirm that the item

was containerized into the two Short Box containers.

1. Open the mobile device, sign in to warehouse 63 and go to Inventor y > Adjust InInventor y > Adjust In .

2. Enter LocLoc = SHORT-01. Make a new license plate with ItemItem = A0001 and QuantityQuantity  = 1 pcs.

3. Select OKOK. You will receive the error "Location SHORT-01 failed because item A0001 does not fit in location's

specified dimensions." This is because the Storage type dimensions of the product are larger than the

dimensions specified on the location profile.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Set up containerization
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Set up a wave template

Set up a container type

This topic describes how to automate the containerization of loads in Warehouse management. Automated

containerization creates containers and the picking work for shipments when a wave is processed and work

lines can be split into quantities that fit the containers. This helps warehouse workers to pick the items directly

into the chosen container. Compared to the manual packing process, tasks such as creating containers, assigning

items, and closing containers are automated by the system. This procedure uses the USMF demo company and

is performed by a Warehouse manager.

1. In the navigation pane, go to Modules > Warehouse management > Setup > Waves > WaveModules > Warehouse management > Setup > Waves > Wave

templatestemplates .

2. Select NewNew .

3. In the Wave template nameWave template name field, type a value.

4. In the Wave template descr iptionWave template descr iption field, type a value.

5. In the S iteSite field, enter or select a value.

6. In the WarehouseWarehouse field, enter or select a value.

7. Expand the MethodsMethods  section. The Selected methodsSelected methods  pane lists the methods for the selected wave template

type. The wave template must include the containerize method.

8. In the Wave step codeWave step code field, type a value. Enter a Wave step code for the added method, which can be any

code. It's possible to add the method more than once and assign different wave step codes. To do this, select

Repeatable for this methodRepeatable for this method in the Wave process methodsWave process methods  page.

9. Select SaveSave.

10. Close the page.

1. In the navigation pane, go to Modules > Warehouse management > Setup > Containers >Modules > Warehouse management > Setup > Containers >

Container typesContainer types . You can define your containers in the Container typesContainer types  page. You can configure the

physical dimensions of containers including tare weight, maximum weight, maximum volume, length, width,

and height. In this example, we have three different sizes of boxes.

2. Select NewNew .

3. In the Container type codeContainer type code field, type a value.

4. In the Tare weightTare weight field, enter a number.

5. In the Maximum weightMaximum weight field, enter a number.

6. In the VolumeVolume field, enter a number.

7. In the LengthLength field, enter a number.

8. In the WidthWidth field, enter a number.

9. In the HeightHeight field, enter a number.

10. In the Descr iptionDescr iption field, type a value.

11. Select SaveSave.

12. Repeat steps 2-11 two more times to make three total container types.

13. Close the page.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/tasks/set-up-containerization.md


Set up a container group

Set up a container build template
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1. In the navigation pane, go to Modules > Warehouse management > Setup > Containers >Modules > Warehouse management > Setup > Containers >

Container groupsContainer groups .

2. On the Action Pane, select NewNew . You can set up logical groups of container types. For each group, you can

specify the sequence in which to pack the containers and the percentage of the containers to fill.The size

dimensions of the item is used to determine whether it will fit in a container. The container that is closest to

the size dimensions of the item is used. If you have multiple container types in a group, we recommend that

you arrange the sequence by size, so that the largest container is first, number 1 in the sequence, and the

smallest container is last.

3. In the Container group IDContainer group ID field, type a value that you created earlier.

4. In the Descr iption fieldDescr iption field, type a value.

5. Repeat steps 2-4 for all three container types you created earlier.

6. Select SaveSave.

7. Close the page.

1. In the navigation pane, go to Modules > Warehouse management > Setup > Containers >Modules > Warehouse management > Setup > Containers >

Container build templatesContainer build templates .

2. Select NewNew . The container build template is based on which of the containerization processes are performed.

Each container build template defines one containerization process that will be used by a wave template. The

Edit quer yEdit quer y  option allows you to define the conditions on which the selected template will be processed. For

example, you may want to only run containerization for specific customers, products, or warehouses or you

can add the corresponding query ranges to the template. The Wave step codeWave step code field is how a container build

template is linked to steps in a wave template. When a wave is executed, it determines which container build

template(s) are used to initiate containerization. The Base query type field determines what to pack and what

to base the filter query on.

3. In the Container template IDContainer template ID field, type a value.

4. In the Container group IDContainer group ID field, enter or select a value.

5. In the Wave step codeWave step code field, type a value.

6. Select the Allow split picksAllow split picks  check box.

7. Select SaveSave.

8. Select Container mixing constraintsContainer mixing constraints . Mixing logic breaks allows you to set up rules for packing allocation

lines in containers. For example, if you add the Item number fieldItem number field, when items are assigned to containers, a

new container will be created when there is a new item number. This is will prevent workers from packing

allocations lines for two different customers in the same container.

9. Select NewNew .

10. In the TableTable field, select an option.

11. In the Field SelectField Select field, enter or select a value.

12. Select OKOK.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Where it applies

IMPORTANTIMPORTANT

Set up batch and license plate confirmation

NOTENOTE

Batch confirmation allows you to confirm that the correct batch is being picked from the mobile device. On the

initial pick of work for batch above-items only, where batch above indicates that batch ranges higher than

location in the search hierarchy, you must verify that the batch that is picked matches the batch on the work line.

License plate confirmation allows you to confirm that the correct license plate is being picked from the mobile

device. When picking work from a stage location, you must verify that the license plate that is picked matches

the license plate that is associated with the work. If the work is started by scanning a license plate, this

confirmation step will be skipped.

Confirmation applies in the following scenarios:

Batch confirmation applies to the initial picks of work for batch above-items.

License plate confirmation applies to picks from stage locations.

Replenishment is not supported for license plate confirmation. When executing replenishment work, no license plate

confirmation step is created.

You can configure batch and license plate confirmation from the mobile device menu items.

1. From the mobile device menu items, enter the work confirmation setup.

2. Select the option for either batch or license plate confirmation. Both options are available for work type picks

that do not have automatic confirmation enabled.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/batch-and-license-plate-confirmation.md
https://aka.ms/BAG_Docs_Language_Survey
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Enable license plate label printing
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Set up the GS1 company prefix

Setup the SSCC license plate number sequence

Create the document route layout

Set up the document routing

This topic shows how to enable the automatic printing of a Serial shipping container code (SSCC) label after the

last item is picked from inventory in a sales picking work process. You can run this procedure in demo data

company USMF. If you're run it using your own data, you need to have a number sequence set up for license

plates. You need to set up a label printer before you begin this task. Go to Organization administration > Setup

> Network printers. On the Action Pane, click Options, and then click the Download document routing agent

installer button. Run the installer and make sure that you have a working network printer set to Active before

you continue with the procedure.

1. Go to Navigation pane > Modules > Warehouse management > Setup > WarehouseNavigation pane > Modules > Warehouse management > Setup > Warehouse

management parametersmanagement parameters .

2. In the GS1 company prefixGS1 company prefix field, enter the 7 numbers for your GS1 company number.

3. Select SaveSave.

4. Close the page.

1. Go to Navigation pane > Modules > Organization administration > Number sequences >Navigation pane > Modules > Organization administration > Number sequences >

Number sequencesNumber sequences .

2. In the AreaArea field, select an option.

3. In the ReferenceReference field, select an option.

4. In the CompanyCompany  field, type a value.

5. Expand the SegmentsSegments  section.

6. Select EditEdit.

7. In the SegmentsSegments  table, select the first row

8. Select RemoveRemove.

9. Select RemoveRemove.

10. Select SaveSave.

11. Close the page.

1. Go to Navigation pane > Modules > Warehouse management > Setup > Document routing >Navigation pane > Modules > Warehouse management > Setup > Document routing >

Document routing layoutsDocument routing layouts . Enable the SSCC layout.

2. Select NewNew .

3. In the Layout IDLayout ID field, type a value.

4. In the Descr iptionDescr iption field, type a value.

5. Select Inser t at end of textInser t at end of text.

6. Select SaveSave.

7. Close the page.
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Create mobile device menu

Update a work template

1. Go to Navigation pane > Modules > Warehouse management > Setup > Document routing >Navigation pane > Modules > Warehouse management > Setup > Document routing >

Document routingDocument routing.

2. In the Work order typeWork order type field, select an option.

3. Select NewNew .

4. In the WarehouseWarehouse field, type a value.

5. In the NameName field, type a value.

6. Select NewNew .

7. In the Layout IDLayout ID field, enter or select a value.

8. In the NameName field, enter the printer name that you want to use.

9. Select SaveSave.

10. Close the page.

1. Go to Navigation pane > Modules > Warehouse management > Setup > Mobile device > MobileNavigation pane > Modules > Warehouse management > Setup > Mobile device > Mobile

device menu itemsdevice menu items .

2. Select NewNew .

3. In the Menu item nameMenu item name field, type a value.

4. In the TitleTitle field, type a value.

5. In the ModeMode field, select an option.

6. Select YesYes  in the Use existing workUse existing work field.

7. Select YesYes  in the Generate license plateGenerate license plate field.

8. Expand the Work classesWork classes  section.

9. Select NewNew .

10. In the Work class IDWork class ID field, type a value.

11. Select SaveSave.

12. Close the page.

13. Go to navigation pane > Modules > Warehouse management > Setup > Mobile device > Mobilenavigation pane > Modules > Warehouse management > Setup > Mobile device > Mobile

device menudevice menu.

14. In the tree, select the menu item that you created before.

15. Select EditEdit.

16. Select the arrow to add the menu item to the menu.

17. Select SaveSave.

18. Close the page.

1. Go to Navigation pane > Modules > Warehouse management > Setup > Work > WorkNavigation pane > Modules > Warehouse management > Setup > Work > Work

templatestemplates .

2. Select EditEdit.

3. Select NewNew .

4. In the Work typeWork type field, select Pr intPr int.

5. In the Work class IDWork class ID field, enter or select a value.

6. Select Move upMove up.

7. Select SaveSave.

8. Close the page.
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Enable the create transfer orders from Warehouse app feature

Set up a mobile device menu item to create transfer orders

This feature lets warehouse workers create and process transfer orders directly from the warehouse app. The

warehouse workers start by selecting the destination warehouse and then they can scan one or more license

plates using the app to add license plates to the transfer order. When the warehouse worker selects CompleteComplete

orderorder , a batch job will create the required transfer order and order lines based on the on-hand inventory

registered for those license plates.

Before you can use this feature, both it and its prerequisites must be enabled on your system. Administrators

can use the feature management page to check the feature status and enable it if needed.

1. First enable the Process warehouse app events feature, which is listed in feature management as:

2. Then enable the Create transfer orders from the warehouse app feature, which is listed as:

3. To automate the processing of the outbound shipments, you must also enable the Confirm outbound

shipments from batch jobs feature. This feature is listed as:

ModuleModule - Warehouse management

Feature nameFeature name - Process warehouse app events

ModuleModule - Warehouse management

Feature nameFeature name - Create and process transfer orders from the warehouse app

ModuleModule - Warehouse management

Feature nameFeature name - Confirm outbound shipments from batch jobs

Here are general guidelines for setting up a mobile device menu item for creating a transfer order. Depending

on your business requirements for the level of automation to be set when users create transfer orders from the

floor, different configurations will be enabled. The scenario in this document will describe one such

configuration.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. Select NewNew  to add a new menu item. Then make the following settings to get started:

Menu item nameMenu item name - Assign a name as it should appear in Supply Chain Management.

TitleTitle - Assign a menu name as it should be presented to workers in the warehouse app.

ModeMode - Set to Indirect (this warehouse app will not create work).

Activity codeActivity code - Set to Create transfer order from license plates to enable the warehouse workers to

create a transfer order based on one or more scanned license plates.

3. Use the Transfer order line creation policyTransfer order line creation policy  setting to control how transfer order lines will be created

by this menu item. The lines will be created/updated based on the on-hand inventory registered for the

scanned license plates. Choose one of the following values:

No reser vationNo reser vation - The transfer order lines will not be reserved.

L icense plate guided with line reser vationLicense plate guided with line reser vation – The transfer order lines will be reserved and use the

License plate guided strategy option, which stores the relevant license plate IDs associated with the

order lines. Located license plate ID values can therefore be used as part of the work creation process

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/create-transfer-order-from-warehouse-app.md
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Create a transfer order based on license plates
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Example scenario

Example Scenario blueprintExample Scenario blueprint

for the transfer order lines.

4. Use the Outbound shipment policyOutbound shipment policy  setting to add more automation to the outbound transfer order

shipment process, as needed. When a worker selects the Complete orderComplete order  button, the app creates the

Complete order warehouse app event, which will save the value you choose here in the OutboundOutbound

shipment policyshipment policy  field for each line in the current transfer order. Later, when the event queue is

processed by a batch job to create the transfer order, the value stored in this field can be read by the

batch job, and may therefore control how that job processes each line. Choose one of the following:

NoneNone - No automated processing is done.

Release to warehouseRelease to warehouse - Automates the release to warehouse process.

Ship confirmShip confirm - Automates the ship confirmation process.

Release and ship confirmRelease and ship confirm - Automates both the release to warehouse and ship confirmation

processes.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menuWarehouse management > Setup > Mobile device > Mobile device menu

2. Select EditEdit.

3. Select an existing menu following selection of the new menu item under Available menus and menuAvailable menus and menu

itemsitems . Add the menu item by selecting the right-arrow button.

The warehouse app has a simple process for creating transfer orders based on license plates. To do this, the

worker does the following using the warehouse app:

1. Create the transfer order and identify the destination warehouse.

2. Identify each license plate to be shipped.

3. Select Complete orderComplete order .

It is possible for multiple workers to assign license plates intended for the same transfer order by using the SelectSelect

transfer ordertransfer order  button to select an existing, unprocessed, transfer order number from the warehouse app event queue.

For information about how to find the transfer order number values, see Inquire the warehouse app events.

This scenario provides an overview of the process for getting transfer orders created and automatically

processed based on the on-hand inventory registered on the selected license plates.

To work through this scenario using the values suggested, you must work on a system with demo data installed

and select the USMF legal entity before you begin.

This scenario assumes that you have already enabled both the Create and process transfer orders from the

warehouse app feature, and the warehouse app event processing capability.

In addition to setting up the create transfer order in the mobile device menu items, additional templates,

location directives, and batch jobs must also be set up and enabled.

You are a retailer and have multiple license plates, each containing a mix of items placed at a specific location

within one of your warehouses (Warehouse 51). You would like to enable the process that allows workers to

create a transfer order to another warehouse (Warehouse 61) for a collection of scanned license plates. You will



Create a mobile device menu item for creating transfer ordersCreate a mobile device menu item for creating transfer orders

Set up work templates to auto process and break work by located license plateSet up work templates to auto process and break work by located license plate

automatically ship-update the transfer order as soon as the last license plate for the order has been identified.

This section explains how to create a new mobile device menu item for creating transfer orders. Set the ModeMode to

Indirect and the Activity codeActivity code to Create transfer order from license plates.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. Select NewNew .

3. In the Menu item nameMenu item name field, enter the name Create TO.

4. In the TitleTitle field, enter the description Create TO.

5. In the ModeMode field, select Indirect.

6. In the Activity codeActivity code, select Create transfer order from license plates

7. In the Order line creation policyOrder line creation policy , select License plate guided with line reservation.

8. In the Outbound shipment policyOutbound shipment policy , select Release and ship confirm.

9. Go to Warehouse management > Setup > Mobile device > Mobile device menuWarehouse management > Setup > Mobile device > Mobile device menu.

10. Select EditEdit.

11. Select the existing Inventor yInventor y  menu and then select the new menu item under Available menus andAvailable menus and

menu itemsmenu items . Add the menu item into to Inventor yInventor y  menu by selecting the right-arrow button.

This section explains how to enable a work template to automatically process the work created by the template

when a wave is released.

1. Go to Warehouse management > Setup > Work > Work templatesWarehouse management > Setup > Work > Work templates .

2. In the Work order typeWork order type field, select Transfer issue.

3. Select NewNew  to create a new work template.

4. In the Work templateWork template field, enter 51 Auto process LP.

5. In the Work template descr iptionWork template descr iption field, enter 51 Auto process LP.

6. Select the Automatically processAutomatically process  check box. This must be selected in order for any automation steps to be

processed.

7. In the demo data, there already exists a work template 51 Transfer, edit the Sequence numberSequence number  field so that

the new work template has a lower sequence number than the existing work template 51 Transfer.

8. Select SaveSave in the toolbar to enable the Work Template DetailsWork Template Details  FastTab.

9. In the Work Template DetailsWork Template Details  FastTab, select NewNew  in the toolbar. You will add two lines.

10. In the Work typeWork type field, select Pick.

11. In the Work class IDWork class ID field, select TransfOut.

12. Select NewNew  in the Work Template DetailsWork Template Details  toolbar.

13. In the Work typeWork type field, select Put.

14. In the Work class IDWork class ID field, select TransfOut.

15. Select SaveSave to enable the Directive codeDirective code field.
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Set up location directives for the license plate guided strategySet up location directives for the license plate guided strategy

NOTENOTE

Set up a batch job to process warehouse app eventsSet up a batch job to process warehouse app events

16. On the Work typeWork type Put line, select Directive codeDirective code Baydoor. Make sure this new work template gets the

lowest Sequence numberSequence number .

17. In the toolbar, select Edit quer yEdit quer y  to open the query editor.

18. In the RangeRange tab, select AddAdd.

19. On the line added, in FieldField select Warehouse.

20. In the Criter iaCriter ia field, select 51.

21. Select the Sor tingSor ting tab.

22. Select AddAdd and set FieldField to Located license plate ID. Selecting this field will enable the toolbar button WorkWork

header breaksheader breaks .

23. Select OKOK followed by YesYes  to reset the grouping and return to the Work templatesWork templates  page.

24. Select Work header breaksWork header breaks  and enable the Group by this fieldGroup by this field for the Located license plate IDLocated license plate ID and

close.

Not all setup can be auto processed, for example, catch weight items and the use of mixed tracking dimensions.

This section explains how to set up a location directive pick process to use the L icense plate guidedLicense plate guided strategy.

1. Go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives .

2. Select EditEdit.

3. In the navigation list header, select the Work order typeWork order type Transfer issue.

4. In the navigation list, select the existing location directive 51 TO Pick51 TO Pick .

5. In the L inesLines  FastTab, select the Allow splitAllow split checkbox.

6. In the Location Directive ActionsLocation Directive Actions  FastTab select NewNew  to add a new action line.

7. In the NameName field, enter LP Guided.

8. In the StrategyStrategy  field, select License plate guided. This action needs the lowest sequence number.

9. Select SaveSave in the toolbar.

10. Select the RefreshRefresh page icon from the toolbar.

11. In the Location Directive ActionsLocation Directive Actions  FastTab, select the line TOPick.

12. In the Location Directive ActionsLocation Directive Actions  toolbar, select Move downMove down to change the sequence number to be

greater than the sequence number for the LP Guided action just created.

The License plate guided strategy will try to reserve and create picking work against the locations holding the requested

license plates that have been associated with the transfer order lines. But if this isn't possible and you still would like to

create picking work, you should fall back to another location directive action strategy, and perhaps also search for

inventory in another area of the warehouse, depending on your business process needs.

This section explains how to set up a scheduled batch job to process warehouse app events.

1. Go to Warehouse management > Periodic tasks > Process warehouse app eventsWarehouse management > Periodic tasks > Process warehouse app events .

2. In the dialog box, enable Batch processingBatch processing under the Run in backgroundRun in background section.

3. Select RecurrenceRecurrence and set up the batch job to process based on the interval needed for your business.

4. Select OKOK to return to the main dialog.

5. Select OKOK in the main dialog to add the job to the batch queue.



Set up a batch job to release transfer orders automaticallySet up a batch job to release transfer orders automatically

Set up the "Process outbound shipment" batch jobSet up the "Process outbound shipment" batch job

This section explains how to set up a scheduled batch job to release the transfer orders that have been marked

as "ready to release".

1. Go to Warehouse management > Release to warehouse > Automatic release of transfer ordersWarehouse management > Release to warehouse > Automatic release of transfer orders .

2. In the dialog box, expand the Records to includeRecords to include section.

3. Select FilterFilter  under the Records to includeRecords to include section.

4. In the WHSTransferAutoRTWQuer yWHSTransferAutoRTWQuer y  query page, RangeRange tab, select AddAdd to add a new line to the query.

5. In the new line TableTable field, select the drop-down menu and select the table Transfer line release toTransfer line release to

warehousewarehouse.

6. In the FieldField drop-down menu, select Outbound shipment policyOutbound shipment policy .

7. In the Criter iaCriter ia field, select Release and ship confirmRelease and ship confirm .

8. In the line where FieldField is set to From warehouse, in the Criter iaCriter ia field, select 51.

9. Select OKOK to return to the main dialog box.

10. Expand the Run in the backgroundRun in the background section to set up batch processing.

11. Enable Batch processingBatch processing under the Run in backgroundRun in background section.

12. Select RecurrenceRecurrence and set up the batch job to process based on interval needed for your business.

13. Select OKOK to return to the main dialog.

14. Select OKOK in the main dialog to have the batch job added to the batch queue.

This section explains how to set up a scheduled batch job to run the outbound shipment confirmation for loads

ready to ship related to transfer order lines that are "ready to ship".

1. Go to Warehouse management > Periodic tasks > Process outbound shipmentsWarehouse management > Periodic tasks > Process outbound shipments .

2. Expand the Records to includeRecords to include section.

3. Select FilterFilter .

4. In the WHSLoadShipConfirmWHSLoadShipConfirm query, select the JoinsJoins  tab.

5. Expand the table hierarchy so that LoadsLoads  and Load detailsLoad details  have been expanded.

6. Select the Load detailsLoad details  table.

7. Select the Add table joinAdd table join button.

8. In the list of table relations, filter or search on the RelationRelation column for Transfer order lines (Reference).

9. Focus on the table relation in the list then press the SelectSelect button.

10. Select the Transfer order linesTransfer order lines  table.

11. Select the Add table joinAdd table join button.

12. In the list of table relations, filter or search on the RelationRelation column for Invent Transfer Additional Fields

(Record-ID).

13. Focus on the table relation in the list then press the SelectSelect button.

14. Select the RangeRange tab.

15. In the RangeRange query tables, you will set up three query criteria ranges. Select the AddAdd button to add a line.

16. Add a range for the table LoadsLoads . Set FieldField to Load status and set Cr iter iaCriter ia to Loaded.

17. Add another range for the table Invent Transfer Additional FieldsInvent Transfer Additional Fields . Set FieldField to Outbound shipment

policy and set Cr iter iaCriter ia to Release and ship confirm.

18. Add another range for the table Load detailsLoad details . Set FieldField to Reference and set Cr iter iaCriter ia to Transfer order

shipment.

19. Select OKOK to return to the main dialog box.

20. Expand the Run in the backgroundRun in the background section.

21. Enable Batch processingBatch processing.

22. Select RecurrenceRecurrence and set up the batch job to process based on interval needed for your business.



        

NOTENOTE

Processing the example for "Create transfer order from the
warehouse app"
Add on-hand on a license plateAdd on-hand on a license plate
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A0002 51 Available LP-010 LP10 2

NOTENOTE

Create and process transfer orders from the warehouse appCreate and process transfer orders from the warehouse app

Inquire the warehouse app eventsInquire the warehouse app events

23. Select OKOK to return to the main dialog.

24. Select OKOK in the main dialog to have the batch job added to the batch queue.

For more information, see Confirm outbound shipments from batch jobs.

As a starting point for this scenario you will need to have a license plate containing physical available inventory

on hand.

Add physical inventory on hand quantities by using the following values:

You will need to create the license plate and use locations that allow you to carry mixed items, like LP-010.

1. Open the app and sign in as user 51. Current user warehouse will be 51.

2. Select the menu item Create TOCreate TO from the menu location you added it to during setup.

3. Start the creation of a transfer order by entering the destination warehouse (To warehouse) in the

WarehouseWarehouse field, enter 61. The new transfer order will be going from current warehouse 51 (From

warehouse) to the destination warehouse 61.

4. Select OKOK.

5. Scan a license plate ID in the L icense plateLicense plate field. Enter the license plate of the inventory added in an earlier

step, LP10.

6. Select OKOK.

7. Select the menu button and then select Complete orderComplete order  to finalize the warehouse app transfer order

creation.

For the mentioned example, two Warehouse app eventsWarehouse app events  (Create transfer order and Complete transfer order)

are used.

You can view the event queue and events messages generated by the warehouse app by going to WarehouseWarehouse

management > Inquir ies and repor ts > Mobile device logs > Warehouse app eventsmanagement > Inquir ies and repor ts > Mobile device logs > Warehouse app events .

The Create transfer order event messages will receive the status Waiting, which means that the ProcessProcess

warehouse app eventswarehouse app events  batch job will not pick up and process the event messages. As soon as the event

message updates to status Queued, the batch job will process the events. This will happen at the same time as

the creation of the Complete transfer order event (when a worker selects theComplete orderComplete order  button on the

warehouse app). When the Create transfer order event messages has been processed, the status is updated to



Follow up on the example scenario processingFollow up on the example scenario processing

Completed or Failed. When the Complete transfer order status is updated to Completed, all the related events

are deleted from the queue.

Because the Warehouse app eventsWarehouse app events  for the creation of transfer order data will not be processed by the batch

job before the messages iss updated to status Queued, you will need to look up the requested transfer order

numbers as part of the IdentifierIdentifier  field. The IdentifierIdentifier  field is in the header of the Warehouse app eventsWarehouse app events

page.

As part of the warehouse event processing, the creation of the transfer order line might fail. In this case, the

state of the event message is updated to Failed and you can use the Batch logBatch log information to learn why and

take action to correct any problems.

Typical issues could be related to missing setup for the process, like a missing transit warehouse for the Create

transfer order event. In an example like this, you would add a transit warehouse to the shipping warehouse and

use the ResetReset option to change the status for all the warehouse app event messages from Failed to Queued,

which means that the batch job will process the event messages again after the correction of the setup data.

Within production environments, the exceptions would be more process related, such as having a requested

license plate, which at the batch job processing time is empty and thereby no transfer order lines are created.

This failed event message can either be removed by using the DeleteDelete option or you can add the needed

physical on-hand on the license plate and use the ResetReset option for all the related event messages.

For more information, see Warehouse app event processing.

During this scenario, the following occurred:

1. Using the warehouse app, you selected a menu item that uses the activity code Create transfer orderCreate transfer order

from license platesfrom license plates .

2. The app prompted you to select the destination warehouse for the transfer order. The source warehouse is

always the one you currently are signed into as a Worker.

3. On the selection of the destination warehouse, the system reserved an ID number for the upcoming transfer

order (based on the transfer-order number sequence defined on your system) but didn't create the transfer

order yet.

4. When you scanned the license plate LP10 containing on-hand inventory that should be moved to the new

warehouse, a Warehouse app eventWarehouse app event was added to the events queue to be processed later. The warehouse

event contained message details about the scan, including the intended transfer-order number.

5. On the warehouse app when the Complete orderComplete order  button is selected, a new warehouse app event,

Complete transfer orderComplete transfer order , is created and the related existing event, Create transfer orderCreate transfer order , changed

status to QueuedQueued.

6. On the back end, the Process warehouse app events batch jobProcess warehouse app events batch job picked up the QueuedQueued event and

collected the on-hand related to the scanned license plate. Based on the on-hand the actual transfer order

record and associated lines got created. The job also populated the Outbound shipment policyOutbound shipment policy  field for

the transfer order with the value based to configured Release and ship confirm and linked the license plate

against the lines for the L icense plate guidedLicense plate guided strategy.

7. Based on the transfer order line Outbound shipment policyOutbound shipment policy  field value the Automatic release ofAutomatic release of

transfer orders batch jobtransfer orders batch job query now resulted in releasing the transfer order to the shipping warehouse.

And due to the setup for the used Wave templateWave template, Work templateWork template, and Location directivesLocation directives  the work got

auto processes resulting on the Load statusLoad status  got updated to Loaded.

8. The Process outbound shipment batch jobProcess outbound shipment batch job is executed for the load, resulting in the transfer order being

shipped and the Advance Shipment Notice (ASN) is generated.

9. The timing of all these events is dependent on the RecurrenceRecurrence settings for the batch jobs created.



Frequently asked questions
Mobile device menu item setupMobile device menu item setup
Why can’t I see "Create transfer order from license plate" in the menu item work activity drop-down list?Why can’t I see "Create transfer order from license plate" in the menu item work activity drop-down list?

Warehouse app processesWarehouse app processes
Why can’t I see the menu button "Complete order"?Why can’t I see the menu button "Complete order"?

Can several warehouse app users add license plates to the same transfer order at the same time?Can several warehouse app users add license plates to the same transfer order at the same time?

Can the same license plate be added to different transfer orders?Can the same license plate be added to different transfer orders?

After having selected the "Complete order" button, can I then add more license plates for that transfer order?After having selected the "Complete order" button, can I then add more license plates for that transfer order?

How can I find existing transfer orders to be used via the "Select transfer order" button in the warehouse app, if the order has notHow can I find existing transfer orders to be used via the "Select transfer order" button in the warehouse app, if the order has not
yet been created in the backend system?yet been created in the backend system?

Can I manually select the transfer order number to be used from the warehouse app?Can I manually select the transfer order number to be used from the warehouse app?

Background processingBackground processing
How should I clean up records in my warehouse app events queue message tables?How should I clean up records in my warehouse app events queue message tables?

Why is the transfer order "Receipt date" not updated according to my "Delivery date control" setup?Why is the transfer order "Receipt date" not updated according to my "Delivery date control" setup?

Can I use a license plate having physical negative inventory on hand?Can I use a license plate having physical negative inventory on hand?

NOTENOTE

The feature Create and process transfer orders from the warehouse app must be enabled. For more information,

see Enable the create transfer orders from Warehouse app.

You must have at least one license plate assigned to the transfer order.

Yes, several warehouse workers can scan license plates into the same transfer order.

No, a license plate can only be added to one transfer order at the time.

No, you can't add more license plates to a transfer order that has a Complete transfer orderComplete transfer order  warehouse app

event.

Currently, you can't look up transfer orders in the app, but you can find the transfer order numbers on the

Warehouse app eventsWarehouse app events  page. For more information, see Inquire the warehouse app events.

Only autogenerated transfer order numbers via number sequences are supported.

You can view and maintain this on the Warehouse app eventsWarehouse app events  page. For more information, see Inquire the

warehouse app events.

The transfer orders are created without using the Deliver y date controlDeliver y date control  capabilities.

The feature only supports positive physical on-hand quantities. Make sure that you have positive physical on-

hand quantities at the warehouse and inventory status level before assigning license plates to a transfer order.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Piece picking confirmation
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Where it applies

Set up piece picking

O P T IO NO P T IO N DESC RIP T IO NDESC RIP T IO N

Piece picking confirmation Available for pick and counting work types. Product
confirmation is automatically selected. Allows you to confirm
each piece of inventory from the mobile device.

Maximum number of pieces Available for pick work if piece picking confirmation is
enabled. Sets a limit to the number of pieces that you must
confirm.

NOTENOTE

Piece picking allows you to confirm each piece of inventory through picking or counting work on a mobile

device. For picks, you can confirm the quantity of work to be processed up to the quantity that is specified on

work to be picked. For counting work, you can scan the inventory that you are counting and track the total

amount.

When you enable piece picking, product confirmation is automatically selected. For work-type picks, a maximum

number of pieces is enabled. This allows you to set a maximum to the number of pieces that must be confirmed

during the work process. The maximum quantity is based on the current work unit that is being processed. The

counting work type does not allow a maximum.

You can also use the quantity and unit of measure (UOM) that is associated with a scanned bar code. This will

work for receiving on inbound flows including mixed license plate receiving, purchase order item, transfer order

item, and load item. It also works for piece picking where scanning the bar code will add the quantity to the total

number of confirmed pieces converting between the UOM on the bar code and the work unit. If, when counting

the UOM on the bar code, it is confirmed that the quantity is allowed for counting on the sequence group, the

quantity will be added to the total count.

Piece picking works for all counting work and for the initial pick for any type of work. Piece picking does not

apply if the item is controlled by serial numbers or if it is a production or kanban pick from a license plate (LP)

location and the item is set to staging.

1. On a mobile device menu item, open the setup form for work confirmation: Warehouse management >

Warehouse managementWarehouse management > SetupSetup > Mobile deviceMobile device > Mobile device menu itemsMobile device menu items .

2. From the mobile device menu item, open Work confirmation setup.

The following options become available for selection when the work type is pick or counting.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/piece-picking-confirmation.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

Set up packing material allocation

Packing material fees are paid to a recycling company at specific intervals. An amount is paid, per unit of weight,

for each material that a packing unit consists of. Although packing material fees are calculated and reported, no

ledger transactions are posted, because the fees aren't considered taxes that must be paid to an authority.

Packing material weights and fees are calculated for sales order lines and purchase order lines.

You can define one or more packing units for a single item, a group of items (packing group), or all items. A

packing unit consists of the packing materials, their weights, and the number of items that are included in the

packing unit. A packing material code is assigned to each type of packing material that is defined. Based on the

packing material code, you can specify a price for a specific period. The packing material fee is calculated based

on this information.

Even if your company doesn't pay packing material fees, you can use the functionality to calculate statistics for the

weights of packing materials.

Before you can calculate packing material weights, packing material fees, or both, you must turn on the

calculation and define which materials and fees apply to which items.

TIPTIP

1. Go to Inventor y management > Setup > Inventor y and warehouse management parametersInventor y management > Setup > Inventor y and warehouse management parameters .

2. On the GeneralGeneral  tab, in the Packing mater ialPacking mater ial  section, set the Calculate packing mater ial feesCalculate packing mater ial fees  option

to YesYes .

3. Go to Inventor y management > Setup > Packing mater ial > Packing groupsInventor y management > Setup > Packing mater ial > Packing groups , and create all the

packing groups that you use. All the items in a packing group will use the same packing material

allocation. If you don't use packing groups, you can skip this step.

After you've created your packing groups, can assign a group to each product as you require. Go to ProductProduct

information management > Products > Released productsinformation management > Products > Released products , select a product, and then, on the ManageManage

inventor yinventor y  FastTab, in the Packing groupPacking group field, select the appropriate packing group.

4. Go to Inventor y management > Setup > Packing mater ial > Packing mater ial codesInventor y management > Setup > Packing mater ial > Packing mater ial codes , define

each type of packing material that you use, and specify the unit that the packing material is consumed in

when you prepare shipments.

5. Go to Inventor y management > Setup > Packing mater ial > Packing mater ial feesInventor y management > Setup > Packing mater ial > Packing mater ial fees , and set a fee

for each type of packing material that you just defined. Fees are calculated based on the price per unit

that is consumed.

6. To allocate packing materials to items, go to Inventor y management > Setup > Packing mater ial >Inventor y management > Setup > Packing mater ial >

Packaging mater ial allocationPackaging mater ial allocation, and create allocations. You can create as many allocations as you

require. You can allocate packing materials for individual items, groups of items (packing groups), or all

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/pack-materials-packing-material-fees.md


Packing units on sales order lines

items, depending on how detailed your allocations should be.

For each allocation that you create, follow these steps.

a. On the GeneralGeneral  FastTab, set the following fields:

NOTENOTE

Item codeItem code – Select the scope of the allocation:

TableTable – Create an allocation for a single specific item.

GroupGroup – Create an allocation for all the items the belong to a packing group that is

defined on the Packing groupsPacking groups  page.

AllAll  – Create an allocation for all items.

Usually, you should make all your allocations at the same level (TableTable, GroupGroup, or AllAll). If you use

more than one level, the most specific matching allocation will be used for each item. (The TableTable

level takes precedence over the GroupGroup level, and both those levels take precedence over the AllAll

level.)

Item relationItem relation – If you're allocating for a single item, select the item. If you're allocating for

a group of items, select the packing group. If you're allocating for all items, leave this field

blank.

ConfigurationConfiguration, S izeSize, ColorColor , and StyleStyle – Enter values for these dimensions as you require,

to further define the item that you're allocating for.

Packing unitPacking unit – Select the unit that the item is packaged in when the packing material is

used. This unit might differ from the unit that the item is purchased and stored in.

Packing unit factorPacking unit factor  – Enter the conversion factor that is used to convert from the

inventory unit to the packing unit. (The conversion uses the formula Packing units = Item

units × Packing unit factor.)

b. On the Packing mater ialPacking mater ial  FastTab, add a line for each piece of packing material that is required for

the current allocation. On each line, specify the type of material (as defined on the PackingPacking

material codesmater ial codes  page) and the amount of it that is consumed for each shipped unit of the current

item.

After you've turned on the calculation for packing material fees and set up your allocations, the system verifies

that packing units are specified for each item that is added to a sales order. It then calculates any fees that are

required. When an item is added to a sales order, one of the following steps occurs:

If a packing allocation applies to the item:If a packing allocation applies to the item: The system updates the sales order line with the specified

packing unit and the packing unit quantity. (The packing unit quantity is calculated by using the formula

Packing unit quantity = Ordered quantity ÷ Number of items in the selected packing unit.)

If no packing allocation applies to the item:If no packing allocation applies to the item: You can manually enter a packing unit and a packing unit

quantity on the sales order line.

You can also change the packing unit and the packing unit quantity when you post the sales order line. This

capability is relevant if the sales order line is only partly delivered or partly invoiced.

When you invoice the sales order, the system creates packing material transactions. Packing material

transactions contain the weights of the packing materials for the sales line. You can modify the transactions after

you invoice them. You can then create new transactions.



Packing units on purchase order lines

Set up license numbers for customers that are charged packing
material fees

Print packing material weights on invoices

NOTENOTE

The system doesn't create packing material transactions for purchase order lines. Instead, you manually create

transactions for invoiced purchase order lines on the Packing mater ial transactionsPacking mater ial transactions  page.

If the sales orders for a specific customer should include charges for the packing materials that are used for each

order, follow these steps.

1. Go to Accounts receivable > Customers > All customersAccounts receivable > Customers > All customers .

2. Select the customer that should be charged for packing materials.

3. On the Invoice and deliver yInvoice and deliver y  FastTab, set the following fields:

In the Sales taxSales tax section, in the Packing duty license numberPacking duty license number  field, enter the company's license

number.

In the Packing mater ial feePacking mater ial fee section, in the L icense numberLicense number  field, enter the company's license

number.

Now, when you create and invoice a sales order that includes one or more items that use packing materials, the

invoice will show the packing material fees.

For customers that should not pay packing material fees, follow these same steps, but clear the license numbers

from the Packing duty license numberPacking duty license number  and L icense numberLicense number  fields. Invoices for customers that don't pay

packing material fees show the weights of the packing materials, but they don't show the fees.

To generate a report that shows all the packing material fees that your company will owe for a specific period,

go to Inventor y management > Inquir ies and repor ts > Packing mater ial repor ts > PackingInventor y management > Inquir ies and repor ts > Packing mater ial repor ts > Packing

material fee calculationmater ial fee calculation, specify a range of dates, and then select OKOK.

You can print packing material weights on an invoice and indicate who pays the related fees. The weights are

summarized by packaging code.

1. Go to Accounts receivable > Setup > Accounts receivable parametersAccounts receivable > Setup > Accounts receivable parameters .

2. On the UpdatesUpdates  tab, on the InvoiceInvoice FastTab, set the Pr int packing mater ial weightPrint packing mater ial weight option to YesYes .

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Set up manual packing (February 2016 & May 2016)
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Set up location profiles

Set up warehouse management parameters

Set up container types

The packing process allows you to validate and pack products into containers. In this process, warehouse

workers pick products from the storage locations and move them to a packing station where they check the

item quantities and types, and assign them to appropriate containers. When a container is fully packed, they can

close it and move it to the outbound docks, and the products are ready to ship. This procedure uses the USMF

demo company. This procedure is for the February 2016 & May 2016 versions of Dynamics 365 for Operations

only.

1. Go to Warehouse management > Setup > Warehouse > Location profiles.

2. Click New.

3. In the Location profile ID field, type a value.

4. In the Name field, type a value.

5. In the Location format field, enter or select a value.

6. In the Location type field, enter or select a value.

7. Select Yes in the Allow mixed items field.

8. Select Yes in the Allow mixed inventory statuses field.

9. Select Yes in the Override rules for batch days field.

10. Close the page.

The location profile is used for packing stations and contains information and rules for a location.

1. Go to Warehouse management > Setup > Warehouse management parameters.

2. Click the Packing tab.

3. In the Profile ID for packing location field, enter or select a value.

4. Close the page.

Select the location profile that you want to use for packing.

1. Go to Warehouse management > Setup > Containers > Container types.

2. Click New.

3. In the Container type code field, type a value.

4. In the Description field, type a value.

5. In the Tare weight field, enter a number.

6. In the Maximum weight field, enter a number.

7. In the Volume field, enter a number.

8. In the Length field, enter a number.

9. In the Width field, enter a number.

You can define the types of containers to use. You can specify the physical dimensions of the container,

including tare weight, maximum weight, maximum volume, length, width, and weight. The Attributes

are customized fields that allow you to add extra dimensions on the container type.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/tasks/set-up-manual-packing-2016-02-05.md


Set up packing profiles

Set up container closing profiles

NOTENOTE

10. In the Height field, enter a number.

11. Click Save.

12. Close the page.

1. Go to Warehouse management > Setup > Packing > Packing profiles.

2. Click New.

3. In the Packing profile ID field, type a value.

4. In the Description field, type a value.

5. In the Container closing profile ID field, enter or select a value.

6. In the Container ID mode field, select an option.

7. In the Container type field, enter or select a value.

8. Select the Autocreate container at container close check box.

9. Click Save.

10. Close the page.

A container closing profile ID is optional and is the default close container profile for this packing

profile.

This option determines whether a container ID will be automatically generated when a container is

created or if a container ID will be created manually.

The container type will be used by default when a new container is created.

1. Go to Warehouse management > Setup > Containers > Container closing profiles.

2. Click New.

3. In the Container closing profile ID field, type a value.

4. In the Description field, type a value.

5. In the Manifest at field, select an option.

6. In the Warehouse field, enter or select a value.

7. In the Default location for final shipment field, enter or select a value.

8. In the Weight unit field, enter or select a value.

9. Click Save.

Container closing profiles define what happens when a container is closed. You can set up multiple

close container profiles.

Specify whether manifesting will occur when closing containers or when confirming the shipment.

Note that manifesting requires Transportation management. Manifesting must be implemented in the

transportation engines in order for it work.

This will be location to which products will be moved after the containers are closed. This location

must have a location profile defined on Warehouse parameters.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Set up short picking item reallocation
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Set up work exceptions

Set up a worker to use manual item reallocation

This procedure shows how to enable warehouse workers to quickly find alternative locations if there isn’t

sufficient inventory at the location they’ve been directed to.

The reallocation process is controlled by a Work exceptionWork exception and used by the warehouse worker.worker.

It is possible to use Automatic, Manual, or both reallocation processes:

Automatic reallocation - Location directives are used to determine if the goods are available at another

location. If possible, the work will be updated and the warehouse user will be directed to the alternative

location.

Manual reallocation - Allows the warehouse user to select from one or more locations with unreserved

quantities of goods.

Automatic and manual - If the system is unable to perform an automatic reallocation, and locations are

available with unreserved quantities, the user will be prompted to select a location.

It's possible to define several work exceptions with different item reallocation policies to enable the warehouse

worker to choose one based on the needs of the shipment that they are processing.

The USMF demo data company was used to create this procedure.

1. In the Navigation paneNavigation pane, go to Warehouse management > Setup > Work > Work exceptionsWarehouse management > Setup > Work > Work exceptions .

2. Click NewNew

3. In the Work exception codeWork exception code field, type a value. This will be the title of this exception . For example, Short

picking manual.

4. In the Descr iptionDescr iption field, type a value. This will be a short description of the usage of this exception. For

example, Short picking - item not available.

5. In the ExceptionException type field, select Shor t pickShor t pick .

6. Select the Adjust inventor yAdjust inventor y  check box. If selected, inventory will automatically be adjusted to 0 at the short

picked location.

7. In the Default adjustment type codeDefault adjustment type code field, enter or select a value. For example, in USMF you can select

Remove Res Adj OutRemove Res Adj Out. Each Adjustment type code contains four characteristics: name, description,

inventory journal name, and Remove reser vationsRemove reser vations . If Remove reser vationsRemove reser vations  is enabled, the short-picked

order line's reservations will be removed.

8. In the Item reallocationItem reallocation field, select a value, such as Manual. If you select Manual, or Automatic and

Manual, the warehouse worker needs to be enabled to use manual reallocation.

The USMF demo data company was used to create this procedure.

1. Close the page.

2. In the Navigation paneNavigation pane, go to Warehouse management > Setup > WorkerWarehouse management > Setup > Worker .

3. Click EditEdit.

4. In the list, select worker. For example, Julia Funderburk.

5. Expand the UsersUsers  FastTab.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/tasks/set-up-short-picking-item-reallocation.md
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6. In the list, select a User IDUser ID. For example, 24.

7. Expand the WorkWork FastTab.

8. Select YesYes  in the Allow manual item reallocationAllow manual item reallocation field.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Warehouse work that can be canceled

NOTENOTE

NOTENOTE

The Cancel work functionality in Microsoft Dynamics 365 Supply Chain Management lets the admin user cancel

specific warehouse work that is currently in progress, but that is blocked by the system or can't be completed

because of exceptional circumstances. This functionality is an attractive and secure alternative to SQL corrective

scripts that fix inconsistent data. However, whereas these scripts are typically requested from IT professionals,

the Cancel work functionality can be used by users in the company who have admin rights.

You can access the Cancel work functionality at Warehouse managementWarehouse management > Periodic tasksPeriodic tasks  > Clean up >Clean up >

Cancel workCancel work . In the Cancel workCancel work dialog box, specify the work ID of the work to cancel, and then select OKOK.

During warehouse picking operations, a worker might encounter situations where they have registered

quantities as picked from a storage location to their user location, but then they can't register the put operation.

Inconsistent warehouse data is often, but not always, the reason why work is blocked.

Unlike the regular Cancel functionality that can be accessed by using the CancelCancel  button on the work header, the

Cancel work functionality doesn't require that the last completed work line be a work line of the putput type. In

other words, for the Cancel work functionality, cancellation logic can be run even if the item quantity on a work

line is in a user location.

For work that must be canceled for operational reasons, warehouse users must continue to use the regular Cancel

functionality on the work page.

Only work of the SalesSales , Transfer issueTransfer issue, Raw mater ial pickingRaw mater ial picking, or ReplenishmentReplenishment type can be canceled by

using the Cancel work functionality. Cancellation logic won't be run for frozen raw material picking work or

work that can be canceled by using the regular Cancel functionality (see the preceding note).

To unblock the work, the system cancels any remaining work lines and fixes the warehouse data that is

associated with the work ID that the user specified. Any regular warehouse-handling operations that involve the

affected item quantity can then resume.

To put the affected item in a specific location after the work is canceled, the user must use an inventory

movement or quantity adjustment operation on a mobile device.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/cancel-warehouse-work.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Turn on the Organization-wide system directed work sequencing
feature

Setup
Make demo data availableMake demo data available

IMPORTANTIMPORTANT

Set up a mobile device menu itemSet up a mobile device menu item

System-directed work sequencing lets you sort and filter the work orders that the system presents to users for

execution. It's helpful in scenarios where additional criteria (such as the time of shipping, the picking zone, the

location profile, or a combination of various criteria) are required to drive the warehouse picking process.

This functionality extends the current system-directed picking functionality by adding a system-directed query

order, where users can set up a sequence and one or more queries that will evaluate all work orders that are

created. Only work orders that meet the criteria that are specified in the setup of the mobile device menu item

will be captured and presented.

Therefore, this functionality allows for further optimization of warehouse picking processes as it identifies work

orders that match the specified criteria, assigns them to the correct mobile device menu item, and then presents

them to a worker, based on a specific skill set, picking equipment, or other requirement.

If different criteria are needed, multiple mobile device menu items must be used.

Before you can use system-directed work sequencing, the feature must be turned on in your system. Admins

can use the Feature management workspace to check the status of the feature and turn it on if it's required.

There, the feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Organization-wide system directed work sequencing

To work through the scenario by using the values that are presented in this topic, you must work on a system

where the standard demo data is installed. Additionally, you must select the USMFUSMF legal entity. The scenario

uses warehouse 51 from the demo data.

Before you release the orders to the warehouse, make sure that the pick locations have enough inventory for all the items

on the orders.

Default USMF data should support this scenario. If you aren't using demo data, review the Location directiveLocation directive setting to

learn which picking locations are used for sales order picking. If you must adjust the inventory, you can create manual

movements, use replenishment, or use any other flow.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. In the list of mobile device menu items, select Sales Picking – SystemSales Picking – System. The required menu item should

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/system-directed-work-sequencing.md


already exist.

3. Confirm the following settings:

W O RK C L A SS IDW O RK C L A SS ID W O RK O RDER T Y P EW O RK O RDER T Y P E

Sales Sales orders

SO Pick Sales orders

On the GeneralGeneral  FastTab, the Directed byDirected by  field should be set to System directed.

The Work classesWork classes  FastTab should show the following settings.

4. On the Action Pane, select System directed work sequence queriesSystem directed work sequence queries .

5. Select EditEdit.

6. Delete the existing line, and then confirm the action by selecting YesYes .

7. On the Action Pane, select NewNew  to create a line.

8. On the new line, set the following values:

Sequence number :Sequence number : 1

Descr iption field:Descr iption field: Work quantity less than 20 and Descending

9. Select SaveSave.

10. On the Action Pane, select Edit Quer yEdit Quer y .

11. On the JoinsJoins  tab, expand the join hierarchy to show the Work linesWork lines  table.

12. Select the Work linesWork lines  table join.

13. Select Add table joinAdd table join .

14. In the list that appears, find and select the row that has the following settings:

Join mode:Join mode: n:1

Relation:Relation: Locations (Location)

15. Select SelectSelect.

Locations are added to the table join.

16. On the Sor tingSor ting tab, select AddAdd to add a line.

17. On the new line, set the following values:

Table:Table: Work lines

Derived table:Derived table: Work lines

Field:Field: Work quantity (In the message box that appears, select YesYes  to add sorting to this field.)

Search direction:Search direction: Descending

18. Select the RangeRange tab.

If only specific work criteria should be included in the sequencing, you can specify them on the RangeRange

tab. In this example, you want to include only work where the quantity is less than 20 ea (the lowest unit

of measure).

Notice that some lines are already included. Those lines should not be removed.
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Location directivesLocation directives

19. Select AddAdd to add a line.

20. On the new line, set the following values:

Table:Table: Work lines

Derived table:Derived table: Work lines

Field:Field: Inventory work quantity

Criter ia:Cr iter ia: <20 (less than 20)

21. Select AddAdd to add another line.

22. On the new line, set the following values:

Table:Table: Work lines

Derived table:Derived table: Work lines

Field:Field: Work type

Criter ia:Cr iter ia: Pick

23. Select AddAdd to add another line.

24. On the new line, set the following values:

IMPORTANTIMPORTANT

Table:Table: Locations

Derived table:Derived table: Locations

Field:Field: Location profile ID

Criter ia:Cr iter ia: !STAGE

Be sure to include the exclamation point (!) in front of STAGE.

25. Select OKOK to save and close the query.

26. Select SaveSave.

27. Close the page to return to the Mobile device menu itemsMobile device menu items page.

This setup defines the criteria that will be used to feed eligible work to the mobile device menu item. If you add more

criteria lines to the query, the system will use the query line that has lowest sequence number first. In other words, all

eligible work for sequence number 1 will be presented to the user first, and then all work for sequence number 2.

Therefore, if a specific range and sorting must be used together, they should be specified in the same system-directed

work sequence query.

This setup will capture any work that has at least one line where the quantity is less than 20 ea. Therefore, if the work has

a line where the quantity is exactly 20 ea or more than 20 ea, it will be valid, provided that it also has at least one line

where the quantity is less than 20 ea.

If you're using default Contoso data, the query for the location directive action won't require changes. However,

to make sure that the location directives will capture the items on the sales orders when you apply the feature in

a non-Contoso environment, create a new location directive. To verify the settings in the demo environment,

follow these steps.

1. Go to Warehouse managementWarehouse management > SetupSetup > Location directivesLocation directives .



Scenario
Create sales order picking workCreate sales order picking work

Sales order 1Sales order 1

Sales order 2Sales order 2

2. In the Work order typeWork order type field, select Sales orders.

3. Select the location directive that is named 51 Pick.

4. On the Location Directive ActionsLocation Directive Actions  FastTab, select the line for the PickPick action.

5. Select Edit quer yEdit quer y  above the grid.

6. Review the RangeRange query.

a. Find the line where the FieldField field is set to Location.

b. Make sure that the Criter iaCriter ia field is blank (that is, there are no restrictions).

Before system-directed picking is run, some outbound work should be created. For this scenario, you will create

four sales orders that are based on the specified system-directed work sequence queries.

You will reserve inventory quantities for each sales order. Therefore, reserved inventory can't be withdrawn

from the warehouse for other orders unless the inventory reservation, or part of the inventory reservation, is

canceled.

You will then release each sales order to the warehouse to create the outbound work.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. On the Action Pane, select NewNew  to create sales order 1.

3. In the Create sales orderCreate sales order  dialog box, set the following values:

In the CustomerCustomer  section, set the Customer accountCustomer account field to US-004.

In the GeneralGeneral  section, set the WarehouseWarehouse field to 51.

4. Select OKOK to close the dialog box. Make a note of the sales order number.

5. Add a line to the new sales order, and set the following values:

Item number :Item number : M9200

Quantity:Quantity: 20

6. On the Inventor yInventor y  menu above the grid, select Reser vationReser vation.

7. On the Reser vationReser vation page, select Reser ve lotReser ve lot to reserve the inventory.

8. Close the Reser vationReser vation page.

9. On the Action Pane, on the WarehouseWarehouse tab, select Release to warehouseRelease to warehouse to create work for the

warehouse.

You receive informational messages that show the wave ID and shipment IDs that were created for the

sales order.

1. On the Action Pane, select NewNew  to create sales order 2.

2. In the Create sales orderCreate sales order  dialog box, set the following values:

Customer account:Customer account: US-007

Warehouse:Warehouse: 51

3. Select OKOK to close the dialog box. Make a note of the sales order number.



Sales order 3Sales order 3

Sales order 4Sales order 4

Get work IDs for the work that was createdGet work IDs for the work that was created

4. Add a line to the new sales order, and set the following values:

Item number :Item number : M9200

Quantity:Quantity: 5

5. Select Add lineAdd line to add a second line, and set the following values:

Item number :Item number : M9201

Quantity:Quantity: 1

6. Reserve inventory for both lines.

7. Release the order to the warehouse.

1. On the Action Pane, select NewNew  to create sales order 3.

2. In the Create sales orderCreate sales order  dialog box, set the following values:

Customer account:Customer account: US-009

Warehouse:Warehouse: 51

3. Select OKOK to close the dialog box. Make a note of the sales order number.

4. Add a line to the new sales order, and set the following values:

Item number :Item number : M9200

Quantity:Quantity: 7

5. Select Add lineAdd line to add a second line, and set the following values:

Item number :Item number : M9202

Quantity:Quantity: 8

6. Reserve inventory for both lines.

7. Release the order to the warehouse.

1. On the Action Pane, select NewNew  to create sales order 4.

2. In the Create sales orderCreate sales order  dialog box, set the following values:

Customer account:Customer account: US-010

Warehouse:Warehouse: 51

3. Select OKOK to close the dialog box. Make a note of the sales order number.

4. Add a line to the new sales order, and set the following values:

Item number :Item number : M9200

Quantity:Quantity: 25

5. Select Add lineAdd line to add a second line, and set the following values:

Item number :Item number : M9202

Quantity:Quantity: 10

6. Reserve inventory for both lines.

7. Release the order to the warehouse.

1. Go to Warehouse management > Work > Work detailsWarehouse management > Work > Work details .

2. Filter on the WarehouseWarehouse field so that only work for warehouse 51 is shown.



Mobile device flow executionMobile device flow execution

Mobile appMobile app

Tips

SA L ES O RDER IDSA L ES O RDER ID W O RK IDW O RK ID W O RK Q UA N T IT YW O RK Q UA N T IT Y

Sales Order 1 Work ID 1 20 ea

Sales Order 2 Work ID 2 6 ea (sum of both lines)

Sales Order 3 Work ID 3 15 ea (sum of both lines)

Sales Order 4 Work ID 4 35 ea (sum of both lines)

3. Four work IDs should have been created. Make a note of the work ID for each sales order.

Before you run the flow on the mobile device, make sure that only the work that you just created is in Open

status for warehouse 51 and the Sales order work order type. Otherwise, the results of the test might vary,

because the system-direct picking will include all eligible work.

1. Go to Warehouse management > Work > Outbound > Open sales workWarehouse management > Work > Outbound > Open sales work .

2. In the Open sales workOpen sales work grid, filter on the WarehouseWarehouse field so that only work for warehouse 51 is shown.

3. Confirm that only the four work IDs that you created earlier are shown.

4. Close the WorkWork page.

Based on the setup, the system will feed the user work that is sorted from the highest work line quantity to the

lowest. The quantity on every line will be less than 20 ea.

Remember that this setup will capture any work that has at least one line where the quantity is less than 20 ea.

Therefore, if the work has another line where the quantity is exactly 20 ea or more than 20 ea, it will also be

valid.

1. Sign in to the warehousing app as a user in warehouse 51.

2. Go to Outbound > Sales Picking - SystemOutbound > Sales Picking - System.

The pick step for work ID 4 is presented. This work ID is presented first because of the setup of the

system-directed query order, where you specified that work should be sequenced based on descending

work line quantity.

3. Complete the required pick and put to close the work ID.

Next, work ID 3 is presented. One of its work lines is next in the sequence, based on the work line

quantity.

4. Complete the pick and put to close the work ID.

Next, work ID 2 is presented. This work's pick line is next in the sequence.

5. Complete the pick and put to close the work ID.

No further work should be presented to you. Work ID 1 isn't eligible for this mobile device menu item,

because the query specifies that work headers are considered only if the quantity on the work lines is less

than 20 ea.

The system-directed work sequence queries are inclusive. It's important that you remember this fact for some

setups. For example, you want a specific menu item to process only work where the work unit is ea, and you
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specify that restriction on the RangeRange tab of the query. In this case, all work where at least one work line has the

work unit set to ea will be fed to the worker. Therefore, this work might also include work where work lines have

a work unit other than ea (such as box or pallet). The query will exclude only work where no work line has the

work unit set to ea.

Therefore, in the example from this scenario, work ID 4 was also captured by the query. When it was created,

two lines were added: one for 25 ea and another for 10 ea. The work was still presented to the user, because at

least one work line has a quantity of less than 20 ea.

Depending on the scenario, you can prevent this behavior by using work breaks.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Turn on the pick line grouping feature

Set up pick line grouping
Create a mobile device menu itemCreate a mobile device menu item

Set up a mobile device menuSet up a mobile device menu

Pick line grouping enables multiple work lines that have the same item and location to be combined into a

single pick that is presented to the user on the mobile device. Therefore, warehouse workers can receive the

most efficient instructions, but required work line separation (for different containers, orders, and so on) can still

be maintained in the system.

Before you can use this feature, it must be turned on in your system. Administrators can use the Feature

management workspace to check the status of the feature and turn it on if it's required. There, the feature is

listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Pick line grouping

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. On the Action Pane, select NewNew .

3. In the Menu item nameMenu item name field, enter Sales group line picking.

4. In the TitleTitle field, enter Sales group line picking. This title will be shown on the mobile device menu.

5. In the ModeMode field, select Work.

6. Set the Use existing workUse existing work option to Yes.

7. On the GeneralGeneral  FastTab, set the following values:

In the Directed byDirected by  field, select User directed.

Set the Generate license plateGenerate license plate option to Yes.

Set the Group pickGroup pick option to Yes.

Accept the default values for the remaining options.

8. Follow these steps to configure the valid work classes for the mobile device menu item:

a. On the Work classesWork classes  FastTab, elect NewNew .

b. In the Work class IDWork class ID field, you can select either Sales or SO Pick, depending on the warehouse

that you will use. For this scenario, select SO Pick.

The Work order typeWork order type field is automatically set to Sales orders.

Follow these steps to add the menu item that you just created to the OutboundOutbound menu.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menuWarehouse management > Setup > Mobile device > Mobile device menu.

2. On the Action Pane, select EditEdit.

3. The list pane shows all existing mobile device menus. Select Outbound in the list.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/pick-line-grouping.md
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IMPORTANTIMPORTANT

Example
Create picking workCreate picking work

4. In the Available menus and menu itemsAvailable menus and menu items list, find and select the Sales group line picking menu item that

you created.

5. Select the right arrow button to move the Sales group line picking menu item to the Menu structureMenu structure list.

6. Use the up arrow and down arrow buttons to move the menu item into the desired position in the menu

structure.

7. On the Action Pane, select SaveSave.

1. Go to Warehouse management > Setup > Work > Work templatesWarehouse management > Setup > Work > Work templates .

2. In the Work order typeWork order type field, select Sales orders.

3. In the Over viewOver view  grid, find and select the work template that should be used with this function. For this

scenario, select the 51 Pick to stage template.

4. On the Action Pane, select Edit quer yEdit quer y .

5. In the query editor dialog box, on the Sor tingSor ting tab, select AddAdd, and then set the following values for the

new row:

In the TableTable column, select Temporary work transactions.

In the Derived tableDerived table column, select Temporary work transactions.

In the FieldField column, select Item number.

In the Search directionSearch direction column, select Ascending.

6. Select OKOK to close the dialog box and save your selection.

7. You receive the following message: "Grouping will be reset, continue?" Select YesYes  to continue.

For the pick line grouping functionality to work, the work lines must be sorted by item ID. If lines that have the same

items aren't sequenced one after another, they won't be grouped.

Before you can set up pick line grouping, you must create some eligible outbound work.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. Select NewNew  to create a sales order.

3. In the Customer accountCustomer account field, select US-004.

4. On the GeneralGeneral  FastTab, in the WarehouseWarehouse field, select 51.

5. Select OKOK.

6. On the Sales order linesSales order lines  FastTab, add the following six lines:

L ine 1:L ine 1: In the Item numberItem number  field, select M9200. In the QuantityQuantity  field, enter 3.

L ine 2:L ine 2: In the Item numberItem number  field, select M9201. In the QuantityQuantity  field, enter 3.

L ine 3:L ine 3: In the Item numberItem number  field, select M9202. In the QuantityQuantity  field, enter 2.

L ine 4:L ine 4: In the Item numberItem number  field, select M9200. In the QuantityQuantity  field, enter 1.

L ine 5:L ine 5: In the Item numberItem number  field, select M9200. In the QuantityQuantity  field, enter 3.

L ine 6:L ine 6: In the Item numberItem number  field, select M9202. In the QuantityQuantity  field, enter 7.



Initiate picking from the mobile deviceInitiate picking from the mobile device

Here is a summary of the total quantities for each item:

Item M9200:Item M9200: 7 each

Item M9201:Item M9201: 3 each

Item M9202:Item M9202: 9 each

7. Before you release the orders to the warehouse, you must make sure that the pick locations have enough

inventory for all the items on all the orders. Review the Location directiveLocation directive setting to determine which

picking locations are used for sales order picking. If you're using the Contoso demo data environment for

warehouse 51, confirm that there is available inventory.

You must now reserve the inventory for each line.

8. On the Sales order linesSales order lines  FastTab, select one of the lines that must be reserved.

9. On the Inventor yInventor y  menu above the grid, select Reser vationReser vation.

10. On the Reser vationReser vation page, on the Action Pane, select Reser ve lotReser ve lot to apply the reservation. Then close

the page.

11. Repeat steps 8 through 10 for the remaining lines that must be reserved.

You must now release the sales order to the warehouse.

12. On the Action Pane, on the WarehouseWarehouse tab, select Release to warehouseRelease to warehouse.

You receive a message that states that a shipment and a wave have been created, and that the wave has

been submitted to run in a batch.

When the wave and all downstream jobs have been completed, a work ID is created for work that has six

lines. The lines are sorted by item number.

13. Go to Warehouse management > Work > All workWarehouse management > Work > All work to view the work that was created. Make a note

of the Work IDWork ID value, because you will need it in the next procedure.

IMPORTANTIMPORTANT

1. Sign in to the mobile device as a user who is set up for warehouse 51.

2. On the mobile device, select the menu that includes the new mobile device menu item. For this scenario,

select OutboundOutbound.

3. Select the Sales group line pickingSales group line picking menu item to initiate the pick.

4. Enter the Work IDWork ID value that you made a note of in the previous procedure.

You should see a pick step where all pick lines for item M9200 are grouped, and you should receive an

instruction to pick 7 each of item M9200.

On the mobile device, the pick work for the three pick work lines has been aggregated into one picking step for

the user.

5. Confirm the pick step.

6. Go to the work page for the work ID, and notice that all three pick lines for item M9200 were closed

simultaneously.

7. Go back to the mobile device, and continue to pick. Work line 4 for item M9201 should be presented.

Because there was only one work line on the order, there is nothing to aggregate.



IMPORTANTIMPORTANT
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8. Confirm the pick step.

9. The last pick step on the mobile device aggregates the last two pick lines from the work order.

10. Complete the pick step for 9 each of item M9202.

11. Confirm the put step and any additional pick/put pairs to complete the work.

Work lines can be grouped only if they are in sequence.

The following functionality isn't supported:

Catch-weight items

If there are any catch-weight items on the work, you receive an error message before you start to pick.

Piece picking

Work lines that have unfinished replenishment work

Over-picking

Short picking with item reallocation

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Turn on the warehouse slotting features

Set up warehouse slotting

Several warehouse slotting features are available to help warehouse managers intelligently plan picking

locations before they release orders to the warehouse and create picking work.

The Warehouse slotting feature lets you consolidate demand by item and unit of measure from orders that have

a status of Ordered, Reserved, or Released. Generated demand can then be applied to locations that will be used

for picking, based on quantity, unit, physical dimensions, fixed locations, and more. After the slotting plan has

been established, replenishment work can be created to bring the appropriate amount of inventory to each

location.

The Warehouse slotting for transfer orders feature lets warehouse managers replenish picking locations, based

on demand from transfer orders that aren't yet released to the warehouse. It ensures that picking locations will

include all the items that are required for the transfer orders after they are released to warehouse. This feature

requires that you also turn on the Warehouse slotting feature feature.

The Warehouse slotting allocation enhancements feature adds an option for the template lines that are used by

the Warehouse slotting feature feature. The option enables the system to consider existing on-hand inventory at

a target location. Therefore, fewer replenishments might be generated for slotting. The Warehouse slotting

allocation enhancements feature requires that you also turn on the Warehouse slotting feature feature. It can

optionally be used together with the Warehouse slotting for transfer orders feature.

Before you can use these features, they must be turned on in your system. Admins can use the feature

management settings to check the status of the features and turn them on if they are required. Turn on the

following features as required:

IMPORTANTIMPORTANT

IMPORTANTIMPORTANT

Warehouse slotting feature

Warehouse slotting for transfer orders

The Warehouse slotting feature feature must be turned on before this feature.

Warehouse slotting allocation enhancements

The Warehouse slotting feature feature must be turned on before this feature.

To use warehouse slotting, you must set up the following elements in your system:

Slotting unit of measure tiers

Directive codes

Slotting templates

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/warehouse-slotting.md


  Create unit-of-measure tiers for slottingCreate unit-of-measure tiers for slotting

Create a directive code for slottingCreate a directive code for slotting

Set up slotting templatesSet up slotting templates

Location directives

Unit-of-measure tiers enable multiple units of measure to be grouped together for the purposes of slotting. For

example, if multiple sizes of boxes are all picked from the same box picking area, one tier can be created for all

the sizes. A line must be created for each unit of measure that should be par t of the tier.A line must be created for each unit of measure that should be par t of the tier.

1. Go to Warehouse management > Setup > Replenishment > S lotting unit of measure tiersWarehouse management > Setup > Replenishment > S lotting unit of measure tiers .

2. Select NewNew .

3. In the header, set the following values:

Unit of measure tier :Unit of measure tier : EaBoxPl

Descr iption:Descr iption: Each box pallet

4. Select SaveSave.

5. On the Units of measureUnits of measure FastTab, select NewNew  to add a line to the grid.

6. On the new line, set the following values:

Unit:Unit: Box

Descr iption:Descr iption: Leave this field blank. It will be filled in automatically when you save your changes.

Unit class:Unit class: Quantity

7. Select NewNew  to add a second line to the grid.

8. On the new line, set the following values:

Unit:Unit: ea

Descr iption:Descr iption: Leave this field blank. It will be filled in automatically when you save your changes.

Unit class:Unit class: Quantity

9. Select NewNew  to add a third line to the grid.

10. On the new line, set the following values:

Unit:Unit: PL

Descr iption:Descr iption: Leave this field blank. It will be filled in automatically when you save your changes.

Unit class:Unit class: Quantity

11. Select SaveSave to save the tier.

You must select the directive code that should be associated with a template.

1. Go to Warehouse management > Setup > Directive codesWarehouse management > Setup > Directive codes .

2. On the Action Pane, select NewNew .

3. In the Directive codeDirective code field, enter Slotting.

4. In the Directive descr iptionDirective descr iption field, enter Slotting.

Each slotting template controls how inventory is assigned to locations for a specific warehouse. Each template

must include a line for each slotting specification. Use the procedures in this section to set up slotting templates.

1. Go to Warehouse management > Setup > Replenishment > S lotting templatesWarehouse management > Setup > Replenishment > S lotting templates .

2. Select NewNew  to create a template.

Next, you must set up the template header, slotting specifications, and location directives, as explained in the

following subsections. The setup for slotting for transfer orders resembles the setup for slotting for sales orders,



Set up the header for a sales order slotting templateSet up the header for a sales order slotting template

Set up slotting specifications for each templateSet up slotting specifications for each template

but the Demand typeDemand type field is set Transfer orders instead of Sales order.

1. In the header for the template, set the following values:

NOTENOTE

Slotting template:S lotting template: 61

Descr iption:Descr iption: 61

Demand type:Demand type: Sales order

Currently, Sales orders and Transfer orders are the only demand types that are supported. You can select

Transfer orders only if the Warehouse Slotting for transfer orders feature is turned on.

Demand strategy:Demand strategy: Ordered

The following values are available in this field:

OrderedOrdered – The full ordered quantity on the sales order should be considered demand.

Reser vedReser ved – Only the sales order line quantities that are reserved (physical and ordered)

should be considered demand.

ReleasedReleased – The released quantity should be considered demand.

Warehouse:Warehouse: 61

Allow wave demand to use unreser ved quantities:Allow wave demand to use unreser ved quantities: Yes

You can also specify a query to narrow the scope of the demand that is evaluated.

For each sales order template that you create, follow these steps to add a line for each slotting specification.

1. On the S lotting template detailsS lotting template details  FastTab, select NewNew  to create a template line.

2. On the new line, set the following values:

Sequence:Sequence: 1

Descr iption:Descr iption: Fixed location

Minimum quantity:Minimum quantity: 1

This field defines the minimum quantity of demand that is required for the line.

Maximum quantity:Maximum quantity: 1000000

This field defines the maximum quantity of demand that is valid for the line.

Unit:Unit: Leave this field blank.

This field defines the unit of measure that the minimum and maximum quantities refer to.

Unit of Measure Tier :Unit of Measure Tier : EaBoxPl

This field defines the units of measure of demand that are valid for the line. (For more information,

see the Set up unit-of-measure tiers for slotting section earlier in this topic.)

Assign slot cr iter ia:Assign slot cr iter ia: Consider qty

The following values are available in this field:



NOTENOTE

Assume emptyAssume empty  – This system should assume that all locations in the picking area are empty

and should not check those locations for inventory.

Consider qtyConsider qty  – The system should check the locations in the picking area for inventory and

should skip any locations that aren't empty.

Consider on-handConsider on-hand – The system should check whether any target location contains

unreserved quantities for the item on the demand line. If the quantity is large enough to satisfy

at least one unit of the demand line, the generated slotting plan record is reduced by the

available amount. For example, if the demand is 10 cases, and one case is on hand, the located

demand will be nine cases. If the demand is 10 cases, and one each is on hand, the located

demand will be 10 cases. This value is available only when the Warehouse slotting allocation

enhancements feature is turned on.

Directive code:Directive code: Slotting

This field defines the location directive that is used to find the picking location of the

replenishment work.

Overflow location:Overflow location: Leave this field blank.

This field defines the location that inventory that is put to if a location can't be found for the

quantity when the line is processed.

Allow let up:Allow let up: Yes

When this option is set to Yes, if any demand can't be slotted, movement work will be created to

take inventory out of locations where there is inventory, but where nothing was slotted. The

template is then run again. This time, it ignores the inventory in the locations. This functionality

works best when the Assign slot cr iter iaAssign slot cr iter ia field is set to Consider qty.

Fixed location usage:Fixed location usage: Only fixed locations for the product

The following values are available in this field:

Fixed and non-fixed locationsFixed and non-fixed locations  – The system should not be limited to using only fixed

locations.

Only fixed locations for the productOnly fixed locations for the product – The system should slot only to locations that are

fixed locations for the product.

Only fixed locations for the product var iantOnly fixed locations for the product var iant – The system should slot only to locations

that are fixed locations for the product variant.

If the slotting template contains at least one line where the Assign slot criteriaAssign slot criteria field is set to Consider on-hand, let-ups

are no longer allowed for any line in the template.

1. Select SaveSave.

2. Select NewNew  to create a second template line.

3. On the new line, set the following values:

Sequence:Sequence: 2

Descr iption:Descr iption: Other

Minimum Qty:Minimum Qty: 1

Maximum Qty:Maximum Qty: 1000000

Unit:Unit: Leave this field blank.



Set up location directivesSet up location directives

C o n fi g u r e  t h e  L o c a t i o n  d i r e c t i v e s  F a s t Ta bC o n fi g u r e  t h e  L o c a t i o n  d i r e c t i v e s  F a s t Ta b

C o n fi g u r e  t h e  L i n e s  F a s t Ta bC o n fi g u r e  t h e  L i n e s  F a s t Ta b

C o n fi g u r e  t h e  L o c a t i o n  D i r e c t i v e  A c t i o n s  F a s t Ta bC o n fi g u r e  t h e  L o c a t i o n  D i r e c t i v e  A c t i o n s  F a s t Ta b

Unit of measure tier :Unit of measure tier : EaBoxPl

Assign slot cr iter ia:Assign slot cr iter ia: Consider qty

Directive code:Directive code: Slotting

Overflow location:Overflow location: Leave this field blank.

Allow let up:Allow let up: Yes

Use fixed locations:Use fixed locations: Fixed and non-fixed locations

In the query for the second line, you will now specify the criteria that are used to determine what

locations the demand for that line can be slotted to.

4. Select the line where the SequenceSequence field is set to 2.

5. Select Edit quer yEdit quer y .

6. On the RangeRange tab, select AddAdd to add a line to the grid.

7. On the new line, set the following values:

Table:Table: Locations

Derived table:Derived table: Locations

Field:Field: Location profile ID

Criter ia:Cr iter ia: Pick-06 (Select the double plus sign [++++] in the field to expand the list, and then select Pick-

06 - Picking Site 6.)

8. Select OKOK.

At least one location directive must be set up to support slotting picks. Use the procedures in this section to set

up a new replenishment location directive for slotting picks.

1. Go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives .

2. In the left pane, in the Work order typeWork order type field, select Replenishment.

3. On the Action Pane, select NewNew .

4. In the header for the new location directive, in the NameName field, enter 61 Slotting pick.

5. In the Sequence numberSequence number  field, accept the default value.

1. On the Location directivesLocation directives  FastTab, set the following values. Accept the default values for all other

fields.

Work type:Work type: Pick

Site:S ite: 6

Warehouse:Warehouse: 61

Directive code:Directive code: Slotting

2. Select SaveSave to make the L inesLines  FastTab available.

1. On the L inesLines  FastTab, select NewNew  to create a line.

2. On the new line, set the following values.

From quantity:From quantity: 0

To quantity:To quantity: 1000000

3. Accept the default values for the remaining fields.

4. Select SaveSave to make the Location Directive ActionsLocation Directive Actions  FastTab available.
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Scenario
Set up the scenarioSet up the scenario

Use the USMF sample dataUse the USMF sample data

Create demandCreate demand

1. On the Location Directive ActionsLocation Directive Actions  FastTab, select NewNew  to create a line.

2. On the new line, set the following values. Accept the default values for all other fields.

Sequence number :Sequence number : Accept the default value.

Name:Name: Bulk

Strategy:Strategy: None

3. Accept the default values for the remaining fields.

4. Select SaveSave to make the Edit quer yEdit quer y  button available.

1. On the Location Directive ActionsLocation Directive Actions  FastTab, select Edit quer yEdit quer y .

2. On the RangeRange tab, select AddAdd to add a line to the grid.

3. On the new line, set the following values:

Table:Table: Locations

Derived table:Derived table: Locations

Field:Field: Zone ID

Criter ia:Cr iter ia: Bulk (Select the double plus sign [++++] in the field to expand the list, and then select Bulk.)

4. Select OKOK.

For this scenario, use the built-in sample data, and create the records that are described in this section.

To work through this scenario by using the sample records and values that are specified here, you must be on a

system where the standard demo data is installed. Additionally, you must select the USMFUSMF legal entity before

you begin.

Follow these steps to create the demand that you will apply slotting to.

1. Go to Sales and marketing > Sales orders > All sales orderSales and marketing > Sales orders > All sales order .

2. Select NewNew  to create a sales order.

3. In the Create sales orderCreate sales order  dialog box, in the Customer accountCustomer account field, select US-007.

4. In the WarehouseWarehouse field, select 61.

5. Select OKOK.

6. The new sales order is opened. It includes an empty line on the Sales order linesSales order lines  FastTab. On this line,

set the following values:

Item:Item: L0101

Quantity:Quantity: 20

7. Select Add lineAdd line to add a new line, and set the following values:

Item:Item: T0100

Quantity:Quantity: 8

8. Select SaveSave.

9. Select NewNew  to create a second sales order.



Walk through a typical slotting scenarioWalk through a typical slotting scenario

Generate demandGenerate demand

Slotting demandSlotting demand

NOTENOTE

Locate demandLocate demand

Slotting planSlotting plan

10. In the Create sales orderCreate sales order  dialog box, in the Customer accountCustomer account field, select US-008.

11. In the WarehouseWarehouse field, select 61.

12. The new sales order is opened. It includes an empty line on the Sales order linesSales order lines  FastTab. On this line,

set the following values:

Item:Item: T0100

Quantity:Quantity: 1

13. Select SaveSave.

After all the prerequisite elements are in place, as described in the previous section, you're ready to try out the

feature by working through each exercise in this section.

1. Go to Warehouse management > Setup > Replenishment > S lotting templatesWarehouse management > Setup > Replenishment > S lotting templates , and select the

slotting template that you created earlier.

2. On the Action Pane, select Generate demandGenerate demand. This command evaluates all demand that is in the system,

and that matches the slotting template query. The total demand across all orders is then consolidated onto

one line per quantity/unit of measure. An informational message appears when the process is completed.

The slotting demand shows the results of demand generation, based on the setup of the slotting template.

On the Action Pane, select S lotting demandSlotting demand to view the results from the Generate demandGenerate demand command.

The lines in the slotting demand can be edited. You can delete a line, add a new line, or edit the line details.

You can edit demand manually, or you can import it from an external system by using data management. Whatever is in

the slotting demand will be used in the next step, regardless of where it came from.

After demand has been generated, you must use the Locate demandLocate demand command to generate the slotting plan.

On the Action Pane, select Locate demandLocate demand. The slotting process runs. An informational message appears

when the process is completed.

The slotting plan shows the location that each item/quantity was assigned to, whether overflow was used,

whether let-up work was created, and the template line that was used. Any demand that could not be slotted is

highlighted in red.

On the Action Pane, select S lotting planSlotting plan to view the results.



NOTENOTE

Create replenishmentCreate replenishment

Tips
Set up automatic slottingSet up automatic slotting

NOTENOTE

The Generate demandGenerate demand, Locate demandLocate demand, and Run replenishmentRun replenishment  processes are now run in a sandbox. (These

processes are available from the Action Pane on the Slotting templatesSlotting templates page.)

The Generate demandGenerate demand, Locate demandLocate demand, and Run replenishmentRun replenishment  processes have a lock to ensure that they can't

be triggered at the same time. Otherwise, the data that is used could be deleted.

The Generate demandGenerate demand and Locate demandLocate demand processes show a warning if the run didn't generate records, or if the

records are missing information.

When you select Slotting planSlotting plan, the page doesn't have NewNew, EditEdit , or DeleteDelete buttons on the Action Pane, because

the data source can't be edited.

When you select Run replenishmentRun replenishment , the system validates the selected slot template and processes.

After the slotting plan has been created, you must create replenishment work, based on the plan.

On the Action Pane, select Run replenishmentRun replenishment. An informational message appears when the process is

completed. This message indicates the number of headers that were created for the work build ID.

Location directives that will be used are identified based on the directive code that is specified on each template

line.

After all the required elements are in place, you can set up slotting to run automatically by following these steps.

NOTENOTE

1. Go to Warehouse management > Replenishment > Run slottingWarehouse management > Replenishment > Run slotting.

2. Specify the slotting steps to run. Select one or more of the following slotting steps:

Generate demand

Locate demand

Create replenishment work

The slotting steps are progressive. If you want to select Locate demand, you must first select Generate demand.

3. Specify the slotting template to use.

4. Set the recurrence to run automatically, if you want.

For the exercises in the scenario, do notnot set up automatic slotting.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Turn on the feature

Feature requirements

Feature scenarios

TIPTIP

Make sample data availableMake sample data available

This topic explains how to use first in, first out (FIFO) and last in, first out (LIFO) location directive strategies

during picking. These strategies work in conjunction with the aging dates that are recorded for locations to track

when inventory first entered the warehouse. The Location directive inventory picking aging feature uses the

date on the location to determine aging. The Warehouse location status feature updates the date on the location,

based on the date from the license plate.

You can use FIFO and LIFO strategies to ship both batch-tracked items and non-batch-tracked items, based on

the date when the inventory entered the warehouse. This capability can be especially useful for non-batch-

tracked inventory, where an expiration date isn't available to use for sorting.

When inventory is first received or created in the warehouse, the system updates the relevant license plate so

that the current date is shown as the aging date. This date is then used by the location directive strategies to

identify the oldest or newest inventory in the warehouse. If inventory is moved to a location that isn't tracked by

license plate, the location itself is updated with aging information, and this information will then be used by the

strategies.

To make this feature available, turn on the following features in feature management, in this order :

1. Warehouse location status

2. Location directive inventory picking aging

To use this feature, you must set the Enable location statusEnable location status  option set to Yes for every location profile that is

used to store inventory. To set this option for a location profile, go to Warehouse management > Setup >Warehouse management > Setup >

Warehouse > Location profilesWarehouse > Location profiles , and select the location profile. You can find the option on the GeneralGeneral

FastTab.

This section provides examples that show how to set up and use FIFO and LIFO strategies.

This section provides two scenarios, one for FIFO and one for LIFO. The procedures that are provided assume that you will

do both scenarios, in order. We recommend that you do both scenarios, so that you can experience the differences

between the two strategies.

To work through these scenarios by using the sample records and values that are specified here, you must be on

a system where the standard demo data is installed. Additionally, you must select the USMFUSMF legal entity before

you begin.

You can also use these scenarios as guidance for using the feature on a production system. However, in that

case, you must substitute your own values for each setting that is described here.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/location-directive-inventory-picking-aging.md


    Set up the scenariosSet up the scenarios
The demo data requires setup and inventory adjustments to support the scenarios. Follow these steps to create

the inventory data that is required to work through the FIFO and LIFO scenarios.

1. Sign in to a system where demo data is installed, and select the USMFUSMF legal entity.

2. Go to Warehouse management > Setup > Warehouse > Location profilesWarehouse management > Setup > Warehouse > Location profiles .

3. On the Action Pane, select EditEdit.

4. In the list of location profiles, select FLOOR-05FLOOR-05 .

5. On the GeneralGeneral  FastTab, set the Enable location statusEnable location status  option to Yes.

6. Select SaveSave.

7. Go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives .

8. In the list of location directives, select 63 Pick container ization63 Pick container ization.

9. Select EditEdit to put the page into edit mode.

10. On the Location directive actionsLocation directive actions  FastTab, find the line where the Sequence numberSequence number  field is set to 1,

and follow one of these steps:

If you're setting up a FIFO scenario, change the value of the StrategyStrategy  field to Location aging FIFO.

If you're setting up a LIFO scenario, change the value of the StrategyStrategy  field to Location aging LIFO.

11. On the Location directive actionsLocation directive actions  FastTab, select Edit quer yEdit quer y .

12. In the query dialog box, on the RangeRange tab, select AddAdd to add a line, and then set the following values:

Table:Table: Locations

Derived table:Derived table: Locations

Field:Field: Zone ID

Criter ia:Cr iter ia: Floor

13. Select OKOK to apply your settings and close the query dialog box.

14. Select SaveSave to save your changes to the location directive.

15. On a mobile device or in the Dynamics 365 for Finance and Operations - Warehousing app on your PC,

follow these steps to remove existing inventory from the warehouse location to support the scenarios:

a. Sign in to warehouse 63 by using the appropriate user ID and password.

b. On the main menu, select QualityQuality .

c. On the Quality managementQuality management menu, select ScrapScrap.

d. On the ScrapScrap page, select the LOC/LPLOC/LP field, and then enter 63_1.

e. Select EnterEnter  or OKOK.

f. Confirm the ScrapScrap details for Adjustment outAdjustment out by selecting EnterEnter  or OKOK.

When the license plate inventory is adjusted out, you receive a "Work Completed" message.

These steps leave inventory in two locations in the demo data. Each location has a different aging date.

Location FL-001 has an aging date of April 15, 2017, and location FL-002 has an aging date of January

29, 2017. Both locations contain item A0001.

To view this data, go to Inventor y management > Inquir ies and repor ts > On-hand listInventor y management > Inquir ies and repor ts > On-hand list, and then

filter on warehouse 63 and item A0001. In the rows where the LocationLocation field is set to FL-001 or FL-002,

select a line that has a positive Physical inventor yPhysical inventor y  value, and then, on the Action Pane, select

TransactionsTransactions . The Physical datePhysical date field will show a date that corresponds to one of the previously



  Scenario 1: Set up and use FIFO location agingScenario 1: Set up and use FIFO location aging

Scenario 2: Set up and use LIFO location agingScenario 2: Set up and use LIFO location aging

mentioned aging dates.

The FIFO strategy finds the location that contains the oldest aging date, and it allocates picking based on that

aging date.

1. If you haven't already done so, prepare the sample data that is required for this scenario.

2. Go to Sales and marketing > Sales order > All sales ordersSales and marketing > Sales order > All sales orders .

3. Select NewNew .

4. In the Create sales orderCreate sales order  dialog box, set the following values:

On the CustomerCustomer  FastTab, set the Customer accountCustomer account field to US-001.

On the GeneralGeneral  FastTab, set the WarehouseWarehouse field to 63.

5. Select OKOK to create the sales order and close the dialog box.

6. The new sales order is opened. It includes a new, empty row in the grid on the Sales order linesSales order lines  FastTab.

For this order line, set the Item numberItem number  field to A0001 and the QuantityQuantity  field to 1.

7. On the Inventor yInventor y  menu above the grid, select Reser vationReser vation.

8. On the Reser vationReser vation page, select Reser ve lotReser ve lot to reserve the ordered quantity of this item from

inventory at the selected warehouse.

9. Close the Reser vationReser vation page.

10. On the Sales orderSales order  page, on the Action Pane, on the WarehouseWarehouse tab, in the ActionsActions  group, select

Release to warehouseRelease to warehouse. You receive informational messages. The system creates a shipment, adds it to a

new load, and creates the required work.

11. On the Sales order linesSales order lines  FastTab, on the WarehouseWarehouse menu, select Work detailsWork details  to open the work that

was created for this sales order. Notice that the line where the Work typeWork type value is Pick shows a LocationLocation

value of FL-002. This location contains the license plate that has the oldest aging date (FIFO).

12. Select Warehouse > Shipment detailsWarehouse > Shipment details .

13. On the *GeneralGeneral  FastTab, make a note of the wave ID, so that you can use it in scenario 2.

The LIFO strategy finds the location that contains the newest aging date, and it allocates picking based on that

aging date. In scenario 2, you will edit the setup for scenario 1 (FIFO), and reuse the sales order and wave that

were created during that scenario.

1. Before you start this scenario, set up and complete the full FIFO scenario as described in the previous

section. In this scenario, you will reuse the wave and most of the setup that were created for that scenario.

2. Edit the 63 Pick container ization63 Pick container ization location directive so that it uses the Location aging LIFO strategy, as

described in the first part of the Set up the scenarios procedure.

Next, you will modify the wave that was created for the sales order in scenario 1, so that is uses the

Location aging LIFO strategy.

3. Go to Warehouse management > Outbound waves > Shipment waves > All wavesWarehouse management > Outbound waves > Shipment waves > All waves .

4. Select and open the wave that contains the order that you created for the FIFO scenario.

5. On the Action Pane, on the WorkWork tab, select CancelCancel  to cancel the work that you created for the FIFO

scenario.



NOTENOTE

6. On the Action Pane, on the WaveWave tab, in the WaveWave group, select ProcessProcess .

7. When the processing is completed, on the Action Pane, on the WaveWave tab, in the Related informationRelated information

group, select WorkWork to open the work that was created for this wave.

8. On the WorkWork page, on the Over viewOver view  tab, there should be two lines. Select the line where the WorkWork

statusstatus  field is set to Open.

9. Notice that the line where the Work typeWork type value is Pick shows a LocationLocation value of FL-001. This location

contains the license plate that has the newest aging date (LIFO).

In these scenarios, you've seen how the location aging strategy directs work to the inventory location that has

either the oldest inventory or the newest inventory, depending on the selected strategy.

Can you tell us about your documentation language preferences? Take a short survey.
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Turn on the Outbound sorting feature

Setup

Set up a wave templateSet up a wave template

Set up a workerSet up a worker

NOTENOTE

This functionality makes it easier to handle small containers and helps warehouse workers better plan and

organize pallet capacity in the truck. When you use outbound sorting, you can sort packed containers to the

correct pallet after they have been at a packing station. You can also build a packing hierarchy.

This functionality lets you build pallets from containers that are packed through the packing functionality. The

container isn't sent to the final shipping location as it is in the original packing flow. Instead, workers can close

the container and move it to a sort type location. They can then sort containers to positions, each of which has a

license plate (LP). After the containers have been sorted, work can be created to send the whole LP to the final

shipping dock or stage locations, based on location directives or your own requirements. Additionally, the action

of closing of the sort position can immediately move the inventory to the final shipping location and pick it to

the order.

Before you can use the feature, it must be turned on in your system. Admins can use the Feature management

workspace to check the status of the feature and turn it on if it's required. There, the feature is listed in the

following way:

Module:Module: Warehouse management

Feature name:Feature name: Outbound sorting

For this scenario, you must use standard USMFUSMF demo data and warehouse 62. You must also complete the

setup that is described in the following subsections.

This setup automatically processes the wave and creates work when a line is released to the warehouse.

1. Go to Warehouse management > Setup > Waves > Wave templatesWarehouse management > Setup > Waves > Wave templates .

2. In the template list, select Warehouse 62Warehouse 62 .

3. On the GeneralGeneral  FastTab, make sure that the Process wave at release to warehouseProcess wave at release to warehouse option is set to Yes.

The packing station is considered a location. Warehouse workers who sign in at the packing station see and

work on only shipments and containers that are planned at that specific packing location. A user who signs in to

Microsoft Dynamics 365 must be set up as a worker in Warehouse management. If the user's name doesn't

appear in the list of work users, use the following procedure to add it.

These steps assume that the user already exists in the system and has been associated as an employee or worker in the

Human ResourcesHuman Resources module.

1. Go to Warehouse management > Setup > WorkerWarehouse management > Setup > Worker .

2. Select NewNew .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/outbound-sorting.md


Create a location typeCreate a location type

Set up Warehouse management parametersSet up Warehouse management parameters

Set up a location profileSet up a location profile

Set up a locationSet up a location

3. In the WorkerWorker  field, select the target user in the list of employees.

4. Select SelectSelect.

5. On the Action Pane, select SaveSave.

6. On the UsersUsers  FastTab, select NewNew  to create a mobile device account, and set the following values for it:

User ID:User ID: Enter a unique ID.

User name:User name: Enter a name for the ID.

Default warehouse:Default warehouse: 62

Menu name:Menu name: Main

7. On the Action Pane, select SaveSave.

8. The Set passwordSet password dialog box appears, where you can create a simple password that the user can use to

sign in to the mobile app. Set the following values:

Password:Password: Enter a simple password.

Confirm password:Confirm password: Enter the same password again.

9. Select Set passwordSet password.

A notification in the Action Center informs you that the password has been set for the user that you

created.

1. Go to Warehouse management > Setup > Warehouse > Location typesWarehouse management > Setup > Warehouse > Location types .

2. On the Action Pane, select NewNew  to create a location type, and set the following values for it:

Location type:Location type: SORT

Descr iption:Descr iption: Sort

3. On the Action Pane, select SaveSave.

1. Go to Warehouse management > Setup > Warehouse management parametersWarehouse management > Setup > Warehouse management parameters .

2. On the GeneralGeneral  tab, on the Location typesLocation types  FastTab, set the Sor ting location typeSor ting location type field to SORT.

3. On the Action Pane, select SaveSave.

1. Go to Warehouse management > Setup > Warehouse > Location profilesWarehouse management > Setup > Warehouse > Location profiles .

2. On the Action Pane, select NewNew .

3. In the header, set the following values:

Location profile ID:Location profile ID: Sorting

Name:Name: Sorting

4. On the GeneralGeneral  FastTab, set the following values:

Location format:Location format: ASRB (Aisle-Rack-Shelf-Bin)

Location type:Location type: SORT

Use license plate tracking:Use license plate tracking: Yes

Allow mixed items:Allow mixed items: Yes (When you set this option to Yes, the Allow mixed inventor y batchesAllow mixed inventor y batches

option is automatically set to Yes and can't be changed independently.)

5. Select SaveSave.



Set up an outbound sorting templateSet up an outbound sorting template

1. Go to Warehouse management > Setup > Warehouse > LocationsWarehouse management > Setup > Warehouse > Locations .

2. In the header, clear the Generate check digits for locationGenerate check digits for location check box.

3. On the Action Pane, select NewNew  to create a location, and set the following values for it:

Warehouse:Warehouse: 62

Location:Location: SORT

Location profile ID:Location profile ID: SORTING

4. Select SaveSave.

The outbound sorting template determines whether work is created out of the sort location, and whether

sorting is done manually or automatically.

For this scenario, you will create an outbound sorting template to build pallets after the packing station.

1. Go to Warehouse Management > Setup > Packing > Outbound sor ting templateWarehouse Management > Setup > Packing > Outbound sor ting template.

2. On the Action Pane, select NewNew .

3. In the header of the new template, set the following values:

Outbound sor ting template ID:Outbound sor ting template ID: AutoWork

Descr iption:Descr iption: Auto Work Creation

Outbound sor ting template type:Outbound sor ting template type: Container

Warehouse:Warehouse: 62

Location:Location: SORT

4. On the GeneralGeneral  FastTab, set the following values:

Sor t ver ification:Sor t ver ification: Position scan

Create work on position close:Create work on position close: Yes

If this option is set to Yes, when the position is closed, work will be created to move inventory to

the final shipping location. If it's set to No, inventory will immediately be picked to the order when

the position is closed.

Position assignment:Position assignment: Automatic

If this field is set to Manual, the user must always indicate which position the inventory should be

sorted to. If it's set to Automatic, the system will automatically guide the inventory to a position

whenever it can, based on the sort template breaks.

5. Select SaveSave to make the Edit quer yEdit quer y  button on the Action Pane available.

6. On the Action Pane, select Edit Quer yEdit Quer y .

7. In the query editor, on the Sor tingSor ting tab, add a line that has the following values:

Table:Table: Shipments

Derived table:Derived table: Shipments

Field:Field: Carrier service

When you select this value, you might receive the following message: "Field Carrier service is not

an index field. Do you want to add sorting on this?" Select YesYes .

Search direction:Search direction: Ascending



Set up container packing policiesSet up container packing policies

Set up packing profilesSet up packing profiles

Set up work classesSet up work classes

8. Select OKOK.

9. You might receive the following message: "Grouping will be reset, continue?" Select YesYes .

The Outbound sor ting template breaksOutbound sor ting template breaks  button on the Action Pane becomes available.

10. On the Action Pane, select Outbound sor ting template breaksOutbound sor ting template breaks .

11. In the Outbound sor ting cr iter iaOutbound sor ting cr iter ia dialog box, set the following values:

Reference table name:Reference table name: Shipments

Reference field name:Reference field name: Carrier service

Group by field:Group by field: Select this check box to group shipments by carrier service.

12. Select OKOK to save your settings and close the dialog box.

1. Go to Warehouse management > Setup > Containers > Container packing policiesWarehouse management > Setup > Containers > Container packing policies .

2. On the Action Pane, select NewNew .

3. In the header of the new policy, set the following values:

Container packing policy:Container packing policy: Sort

Descr iption:Descr iption: Sort

4. On the Over viewOver view  FastTab, set the following values:

Warehouse:Warehouse: 62

Default location for sor ting:Default location for sor ting: SORT

Weight unit:Weight unit: kg

Container closing policy:Container closing policy: Automatic release

Container release policy:Container release policy: Assign container to outbound sorting position

5. Select SaveSave.

Create a new packing profile that will be used together with the sorting functionality.

1. Go to Warehouse management > Setup > Packing > Packing profilesWarehouse management > Setup > Packing > Packing profiles .

2. On the Action Pane, select NewNew  to create a line, and set the following values for it:

Packing profile ID:Packing profile ID: Sort

Descr iption:Descr iption: Sort

Container packing policy:Container packing policy: Sort

Container ID mode:Container ID mode: Auto

Container type:Container type: Box-Large

Auto create container at container close:Auto create container at container close: Cleared (= No)

3. Select SaveSave.

Set up a work class that will be used together with sorting.

1. Go to Warehouse management > Setup > Work > Work classesWarehouse management > Setup > Work > Work classes .

2. On the Action Pane, select NewNew  to create a work class for sorting, and set the following values for it:

Work class ID:Work class ID: Sort

Descr iption:Descr iption: Sort



Set up mobile device menu itemsSet up mobile device menu items
Set up a new pallet menu itemSet up a new pallet menu item

Set up a new loading menu itemSet up a new loading menu item

Set up the mobile device menuSet up the mobile device menu

Work order type:Work order type: Sorted inventory picking

3. Select SaveSave.

Create a mobile device menu item to build pallets during sorting.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. On the Action Pane, select NewNew .

3. In the header, set the following values:

Menu item name:Menu item name: Pallet build

Title:Title: Pallet build

Mode:Mode: Indirect

Use existing work :Use existing work : No

4. On the GeneralGeneral  FastTab, set the following values:

Activity code:Activity code: Outbound sorting

When this field is set to Outbound sorting, the Outbound sor ting template IDOutbound sor ting template ID field is shown.

Use process guide:Use process guide: Yes

When the Activity codeActivity code field is set to Outbound sorting, this option is automatically set to Yes.

Outbound sor ting template ID:Outbound sor ting template ID: AutoWork

5. Select SaveSave.

Next, create a menu item that lets users move the sorted inventory items to the shipping location.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. On the Action Pane, select NewNew .

3. In the header, set the following values:

Menu item name:Menu item name: Load from Sorting

Title:Title: Load from Sorting

Mode:Mode: Work

Use existing work :Use existing work : Yes

4. On the GeneralGeneral  FastTab, set the Directed byDirected by  field to User directed.

5. On the Work classesWork classes  FastTab, select NewNew , and then set the following values:

Work class ID:Work class ID: SORT

Work order type:Work order type: Sorted inventory picking

6. Select SaveSave.

You must now add the new menu items to the mobile device menu.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menuWarehouse management > Setup > Mobile device > Mobile device menu.

2. Select the OutboundOutbound menu.

3. On the Action Pane, select EditEdit.

4. In the Available menus and menu itemsAvailable menus and menu items column, find and select Pallet buildPallet build.



Set up location directivesSet up location directives

Set up a single-SKU directiveSet up a single-SKU directive

Set up a multiple-SKU directiveSet up a multiple-SKU directive

5. Select the right arrow button to move Pallet buildPallet build to the Menu structureMenu structure column.

6. Use the up arrow and down arrow buttons to put the Pallet buildPallet build menu item in the desired position on the

mobile device menu.

7. Select SaveSave.

8. Repeat this procedure to add the Load from Sor tingLoad from Sor ting menu item to the OutboundOutbound menu.

Location directives are rules that help identify pick and put locations for inventory movement. You must now

create a rule to manage the sorting work.

1. Go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives .

2. In the left pane, change the value of the Work order typeWork order type field to Sorted inventory picking.

3. On the Action Pane, select NewNew .

4. In the header, set the following values:

Sequence:Sequence: 1

Name:Name: Baydoor

5. On the Location directivesLocation directives  FastTab, set the following values:

Work type:Work type: Put

Site:S ite: 6

Warehouse:Warehouse: 62

Multiple SKU:Multiple SKU: No

6. Select SaveSave to make the toolbar on the L inesLines  FastTab available.

7. On the L inesLines  FastTab, select NewNew , and then set the following values on the new line. Accept the default

values for all the other fields.

Sequence:Sequence: 1

From:From: 0

To:To: 1,000,000

8. Select SaveSave to make the toolbar on the Location Directive ActionsLocation Directive Actions  FastTab available.

9. On the Location Directive ActionsLocation Directive Actions  FastTab, select NewNew , and then set the following values on the new

line. Accept the default values for all the other fields.

Sequence:Sequence: 1

Name:Name: Baydoor

10. Select SaveSave.

11. On the Location Directive ActionsLocation Directive Actions  FastTab, select Edit quer yEdit quer y .

12. In the query editor, on the RangeRange tab, find the row where the FieldField field is set to Location. Set the

Criter iaCriter ia field for this row to Baydoor.

13. Select OKOK to save your settings and close the query editor.

1. Go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives .

2. In the left pane, change the value of the Work order typeWork order type field to Sorted inventory picking.

3. On the Action Pane, select NewNew .



Set up work templatesSet up work templates

4. In the header, set the following values:

Sequence:Sequence: 2

Name:Name: Baydoor Multi

5. On the Location directivesLocation directives  FastTab, set the following values:

Work type:Work type: Put

Site:S ite: 6

Warehouse:Warehouse: 62

Multiple SKU:Multiple SKU: Yes

6. Select SaveSave to make the toolbar on the L inesLines  FastTab available.

7. On the L inesLines  FastTab, select NewNew , and then set the following values on the new line. Accept the default

values for all the other fields.

Sequence:Sequence: 1

From:From: 0

To:To: 1,000,000

8. Select SaveSave to make the toolbar on the Location Directive ActionsLocation Directive Actions  FastTab available.

9. On the Location Directive ActionsLocation Directive Actions  FastTab, select NewNew , and then set the following values on the new

line. Accept the default values for all the other fields.

Sequence:Sequence: 1

Name:Name: Baydoor Multi

10. Select SaveSave.

11. On the Location Directive ActionsLocation Directive Actions  FastTab, select Edit quer yEdit quer y .

12. In the query editor, on the RangeRange tab, find the row where the FieldField field is set to Location. Set the

Criter iaCriter ia field for this row to Baydoor.

13. Select OKOK to save your settings and close the query editor.

1. Go to Warehouse management > Setup > Work > Work templatesWarehouse management > Setup > Work > Work templates .

2. Change the value of the Work order typeWork order type field to Sorted inventory picking.

3. On the Action Pane, select NewNew  to create a work template.

4. On the Over viewOver view  tab, set the following values:

Sequence:Sequence: 1

Work template:Work template: Sort

Work template descr iption:Work template descr iption: Sort

5. Select SaveSave to make the Work Template DetailsWork Template Details  FastTab available.

6. On the Work Template DetailsWork Template Details  FastTab, select NewNew  to add a line, and then set the following values for

it:

Work type:Work type: Pick

Work class ID:Work class ID: SORT

7. Select NewNew  again to add a second line, and then set the following values for it:

Work type:Work type: Put

Work class ID:Work class ID: SORT



Scenario

Create sales orders and picking workCreate sales orders and picking work
Create sales order 1Create sales order 1

Sales order 2Sales order 2

8. Select SaveSave.

This scenario simulates a situation where packed containers should automatically be sorted to different

positions (pallets) after the packing station, depending on the shipping carrier service. After all items from the

load are packed and sorted by address, the pallets will be moved to the bay door.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. On the Action Pane, select NewNew .

3. In the Create sales orderCreate sales order  dialog box, set the following values:

Customer account:Customer account: US-005

Warehouse:Warehouse: 62

4. Select OKOK to close the dialog box.

The new sales order is opened.

5. Switch to the HeaderHeader  view.

6. On the Deliver yDeliver y  FastTab, in the Transpor tationTranspor tation section, set the following values:

Shipping carr ier :Shipping carr ier : Air cargo

Carr ier  ser vice:Carr ier  ser vice: Air

7. Switch to the L inesLines  view.

8. If a new, empty line isn't automatically added to the grid on the Sales order linesSales order lines  FastTab, select AddAdd

lineline to add one.

9. On the new order line, set the following values:

Item number :Item number : A0001

Quantity:Quantity: 2

10. While the new order line is still selected on the Sales order linesSales order lines  FastTab, on the Inventor yInventor y  menu

above the grid, select Reser vationReser vation.

11. On the Reser vationReser vation page, select Reser ve lotReser ve lot to reserve the full quantity of the selected line in the

warehouse.

12. Close the Reser vationReser vation page to return to the sales order.

13. On the Action Pane, on the WarehouseWarehouse tab, in the ActionsActions  group, select Release to warehouseRelease to warehouse.

14. You receive an informational message that shows the shipment and wave for this order. Make a note of

the wave ID and shipment ID numbers.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. On the Action Pane, select NewNew .

3. In the Create sales orderCreate sales order  dialog box, set the following values:

Customer account:Customer account: US-006

Warehouse:Warehouse: 62



Get the work IDs from the work detailsGet the work IDs from the work details

Pick items for the sales ordersPick items for the sales orders

4. Select OKOK to close the dialog box.

5. The new sales order is opened. It should include a new, empty line in the grid on the Sales order linesSales order lines

FastTab. Set the following values on this order line:

Item:Item: A0001

Quantity:Quantity: 1

6. On the L ine detailsL ine details  FastTab, on the Deliver yDeliver y  tab, set the Mode of deliver yMode of deliver y  field to Flowe-STD.

7. On the Sales order linesSales order lines  FastTab, select Add lineAdd line, and then set the following values on the second

order line:

Item:Item: A0002

Quantity:Quantity: 1

8. On the L ine detailsL ine details  FastTab, on the Deliver yDeliver y  tab, change the value of the Mode of deliver yMode of deliver y  field to Air

C-Air.

9. On the Sales order linesSales order lines  FastTab, select the first order line. Then, on the Inventor yInventor y  menu above the

grid, select Reser vationReser vation.

10. On the Reser vationReser vation page, select Reser ve lotReser ve lot to reserve the full quantity of the selected line in the

warehouse.

11. Close the Reser vationReser vation page to return to the sales order.

12. On the Sales order linesSales order lines  FastTab, select the second order line. Then, on the Inventor yInventor y  menu above the

grid, select Reser vationReser vation.

13. On the Reser vationReser vation page, select Reser ve lotReser ve lot to reserve the full quantity of the selected line in the

warehouse.

14. Close the Reser vationReser vation page to return to the sales order.

15. On the Action Pane, on the WarehouseWarehouse tab, in the ActionsActions  group, select Release to warehouseRelease to warehouse.

16. You receive an informational message that shows the shipment and wave for this order. Notice that two

wave ID numbers and two shipment ID numbers have been created, one for each mode of delivery for

the sales order lines.

1. Go to Warehouse management > Work > Work detailsWarehouse management > Work > Work details .

2. The page shows the work IDs that have been created from sales orders. Use the wave IDs and shipment IDs

from the sales orders that you created to find the work ID for each wave and shipment. Make a note of those

work IDs, because you will need them in the next steps. Notice that two work IDs were created for the second

sales order. If different items are picked from different locations, separate word IDs are generated.

Complete the created work by using the mobile device to move the items to the pack station.

1. On the mobile device, sign in to warehouse 62 by using the user ID that you created for this scenario (or

the user ID of an existing demo data user).

2. On the main menu, select OutboundOutbound.

3. On the OutboundOutbound menu, select Sales PickingSales Picking.

4. In the IDID field, enter the work ID that was created for sales order 1.

5. Select OKOK.



Pack sales orders into containersPack sales orders into containers
Pack sales order 1 into containersPack sales order 1 into containers

6. On the Sales orders - PickSales orders - Pick  page, enter a target LP that was created for sales order 1. Notice that the

picking location (bulk-001), item (A0001), and quantity (2 pcs) are shown.

7. Select OKOK.

8. Review the information on the Sales orders - PutSales orders - Put page. The LocLoc field should indicate that the picked

items are going to the Pack location.

9. Select OKOK.

On the Scan a work ID / license plate IDScan a work ID / license plate ID page, you receive a "Work Completed" message, which

indicates that the work ID from sales order 1 has been completed.

You will now pick sales order 2.

10. In the IDID field, enter the work ID that was created for sales order 2, where line 1 has item A0001.

11. Select OKOK.

12. On the Sales orders - PickSales orders - Pick  page, enter a target LP. Notice that the picking location (bulk-001), item

(A0001), and quantity (1 pcs) are shown.

13. Select OKOK.

14. Review the information on the Sales orders - PutSales orders - Put page. The LocLoc field should indicate that the picked

items are going to the Pack location.

15. Select OKOK.

On the Scan a work ID / license plate IDScan a work ID / license plate ID page, you receive a "Work Completed" message. This

message indicates that the work ID from line 1 of sales order 2 has been completed.

16. In the IDID field, enter the work ID that was created for sales order 2, where line 2 has item A0002.

17. Select OKOK.

18. On the Sales orders - PickSales orders - Pick  page, enter a target LP. Notice that the picking location (bulk-002), item

(A0001), and quantity (1 pcs) are shown.

19. Select OKOK.

20. Review the information on the Sales orders - PutSales orders - Put page. The LocLoc field should indicate that the picked

items are going to the Pack location.

21. Select OKOK.

On the Scan a work ID / license plate IDScan a work ID / license plate ID page, you receive a "Work Completed" message. This

message indicates that the work ID from line 2 of sales order 2 has been completed.

1. Go to Warehouse management > Packing and container ization > PackWarehouse management > Packing and container ization > Pack .

The Select packing stationSelect packing station dialog box appears. By default, the WorkerWorker  field should be set to the name

of the worker that you set up earlier.

2. Set the following values to view and work on shipments and containers that are planned at the specific

packing location:

S ite:S ite: 6

Warehouse:Warehouse: 62

Location:Location: Pack



Pack sales order 2 into containersPack sales order 2 into containers

Packing profile ID:Packing profile ID: Sort

3. Select OKOK to close the dialog box.

4. On the PackPack page, in the L icense plate or shipmentLicense plate or shipment field, enter the target LP for sales order 1. Then

select the TabTab or EnterEnter  key on your keyboard to move out of the field.

5. On the Action Pane, select New containerNew container .

6. Accept all the default settings, and select OKOK. Make a note of the container ID.

7. On the Item packingItem packing FastTab, set the following values:

Quantity:Quantity: 1

Identifier :Identifier : Item A0001

8. On the Action Pane, select Close containerClose container .

9. In the Close containerClose container  dialog box, select Get system weightGet system weight to have the system update the GrossGross

weightweight field.

10. Select OKOK. The container is moved to the SORT location and is ready for sorting.

11. Create a second container to add the second item from the LP for sales order 1 to a new container.

12. On the Action Pane, select New containerNew container .

13. Accept all the default settings, and select OKOK. Make a note of the container ID.

14. On the Item packingItem packing FastTab, set the following values:

Quantity:Quantity: 1

Identifier :Identifier : Item A0001

15. On the Action Pane, select Close containerClose container .

16. In the Close containerClose container  dialog box, select Get system weightGet system weight to have the system update the GrossGross

weightweight field.

17. Select OKOK. The container is moved to the SORT location and is ready for sorting.

1. On the PackPack page, in the L icense plate or shipmentLicense plate or shipment field, enter the target LP for line 1 of sales order 2.

Then select the TabTab or EnterEnter  key on your keyboard to move out of the field.

2. On the Action Pane, select New containerNew container .

3. Accept all the default settings, and select OKOK. Make a note of the container ID.

4. On the Item packingItem packing FastTab, set the following values:

Quantity:Quantity: 1

Identifier :Identifier : Item A0001

5. On the Action Pane, select Close containerClose container .

6. In the Close containerClose container  dialog box, select Get system weightGet system weight to have the system update the GrossGross

weightweight field.

7. Select OKOK. The container is moved to the SORT location and is ready for sorting.

8. In the L icense plate or shipmentLicense plate or shipment field, enter the target LP for line 2 of the sales order 2. Then select the

TabTab or EnterEnter  key on your keyboard to move out of the field.

9. On the Action Pane, select New containerNew container .



Sort the containersSort the containers

IMPORTANTIMPORTANT

Sort the first containerSort the first container

10. Accept all the default settings, and select OKOK. Make a note of the container ID.

11. On the Item packingItem packing FastTab, set the following values:

Quantity:Quantity: 1

Identifier  field:Identifier  field: Item A0002

12. On the Action Pane, select Close containerClose container .

13. In the Close containerClose container  dialog box, select Get system weightGet system weight to have the system update the GrossGross

weightweight field.

14. Select OKOK. The container is moved to the SORT location and is ready for sorting.

To view the container details, go to Warehouse management > Packing and container ization >Warehouse management > Packing and container ization >

ContainersContainers , and search for the container IDs that were created during packing.

When you access the Pallet buildPallet build menu item on the mobile app to do outbound sorting, you will see a button that is

labeled FullFull. Don't use the FullFull button to sort or close the position.

The FullFull button is provided by default and can't be disabled or removed from the page. It isn't used for the Outbound

sorting feature.

1. On the mobile device, sign in to warehouse 62 by using the user ID that you created for this scenario (or

the user ID of an existing demo data user).

2. On the main menu, select OutboundOutbound.

3. On the OutboundOutbound menu, select Pallet buildPallet build.

4. In the LP/ConLP/Con field, enter the first container ID that is associated with sales order 1.

5. Select OKOK.

6. Because no sort positions currently exist, you must specify one. In the Sor t position IDSor t position ID field, enter SP01.

7. Because no LP is currently associated with sort position SP01, you must specify one. In the LPLP field, enter

PLP01.

8. Select OKOK.

9. Because sort position validation is turned on, you must enter the sort position ID again. In the Sor tSor t

Position IDPosition ID field, enter SP01.

10. Select OKOK.

You receive a "Work completed" message.



TIPTIP

Sort the remaining containersSort the remaining containers

Close the outbound sorting positionsClose the outbound sorting positions

To view the sort position and the LP in it, go to Warehouse management > Packing and containerization >Warehouse management > Packing and containerization >

Outbound sor ting position assignmentsOutbound sor ting position assignments .

The Outbound sor ting position assignmentsOutbound sor ting position assignments page shows all the sort positions that are currently active. The Sor tSor t

position transactionsposition transactions field shows the LP that is associated with each sort position, and the containers that are in the

sort position. Notice that one sort position currently exists, and that the Sor t position criteriaSor t position criteria FastTab shows a criterion

of Shipment – Carrier ser vice - AirShipment – Carrier ser vice - Air .

1. On the mobile device, sign in to warehouse 62 by using the user ID that you created for this scenario (or

the user ID of an existing demo data user).

2. On the main menu, select OutboundOutbound.

3. On the OutboundOutbound menu, select Pallet buildPallet build.

4. In the LP/ConLP/Con field, enter the second container ID that is associated with sales order 1.

5. Select OKOK. Because the sorting template is set up to sort automatically, and a sort position that has

matching criteria already exists, you're automatically directed to the correct sort position.

6. Select OKOK.

7. Confirm the sort position ID to indicate that the inventory is in the correct place. In the Sor t Position IDSor t Position ID

field, enter SP01.

8. Select OKOK.

Work is completed on the second container from sales order 1. You will now sort the remaining

containers from sales order 2.

9. In the LP/ConLP/Con field, enter the container ID of the container from sales order 2 that holds item A0001.

Because the carrier service differs, you're prompted to enter a new sort position and assign an LP to that

position. Use sort position SP02 and LP PLP02.

10. Select OKOK.

11. Confirm the sort position by entering SP02 in the Sor t Position IDSor t Position ID field.

12. Select OKOK.

Work is completed on the container.

13. In the LP/ConLP/Con field, enter the container ID for the remaining container from sales order 2 that holds item

A0002. Because the carrier service is the same as the carrier service for sales order 1, the system shows

the existing sort position that has matching criteria.

14. Select OKOK.

15. Confirm the sort position by entering SP01 in the Sor t Position IDSor t Position ID field.

16. Select OKOK.

Work is completed on the container.

When all inventory has been sorted, the position must be closed before work can be created. Sorted inventory

picking work will be created to take the inventory to the bay door.



Close a position from the mobile deviceClose a position from the mobile device

Close a position from outbound sorting position assignmentsClose a position from outbound sorting position assignments

Sorted inventory pickingSorted inventory picking

1. On the mobile device, sign in to warehouse 62 by using the user ID that you created for this scenario (or

the user ID of an existing demo data user).

2. On the main menu, select OutboundOutbound.

3. On the OutboundOutbound menu, select Pallet buildPallet build.

4. In the LP/ConLP/Con field, enter a container ID that was sorted to sort position SP01.

5. Select OKOK.

6. You receive the following message: "The container is already sorted to position SP01. Close the position?"

Select CloseClose.

Work is completed.

TIPTIP

1. Go to Warehouse management > Packing and container ization > Outbound sor ting positionWarehouse management > Packing and container ization > Outbound sor ting position

assignmentsassignments .

2. In the left column, select SP02SP02 . This outbound sorting position row is the one that you will close.

3. On the Action Pane, select Close positionClose position. The sorting position record is closed and is no longer shown.

To show all closed position records, select the Show closedShow closed check box.

You must complete the sorted inventory picking work. When it's completed, the inventory will be picked to the

sales order. At that point, all other warehouse processes apply.

1. On the mobile device, sign in to warehouse 62 by using the user ID that you created for this scenario (or

the user ID of an existing demo data user).

2. On the main menu, select OutboundOutbound.

3. On the OutboundOutbound menu, select Load from Sor tingLoad from Sor ting.

4. Enter the target LP ID from the first sort position, SP01. Set the IDID field to PLP01.

5. Select OKOK.

6. The Sor ted inventor y picking: PickSor ted inventor y picking: Pick  page shows the pick work that must be done. Pick from the SORT

location and target LP PLP01, which has multiple items and a quantity of 3.

7. Select OKOK.

8. The Sor ted inventor y picking: PutSor ted inventor y picking: Put page shows the put work that must be done. Put to the Baydoor

location and target LP PLP01, which has multiple items and a quantity of 3.

9. Select OKOK.

Work is completed.

10. Enter the target license plate ID from the second sort position, SP02. Set the IDID field to PLP02.

11. Select OKOK.

12. The Sor ted inventor y picking: PickSor ted inventor y picking: Pick  page shows the pick work that must be done. Pick from the SORT



NOTENOTE

location and target LP PLP02, which has multiple items and a quantity of 1.

13. Select OKOK.

14. The Sor ted inventor y picking: PutSor ted inventor y picking: Put page shows the put work that must be done. Put to the Baydoor

location and target LP PLP02, which has multiple items and a quantity of 1.

15. Select OKOK.

Work is completed.

From this point forward, all other warehouse processes apply.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Turn on the Outbound sorting feature

Setup

Location typeLocation type

Warehouse management parametersWarehouse management parameters

The Put to wall - put to store functionality lets you handle scenarios where you must consolidate a product to a

prepack staging area, based on configurable criteria. Because this functionality allows for picking to a single

target license plate and can use more put positions than cluster picking, companies that ship to stores or handle

small items will benefit from decreased picking time.

The workflow for this functionality directs picked product to a sorting location for distribution into various types

of containers. Generally, each sorting location includes multiple sort positions. Each sort position is assigned

according to the criteria that are set by the business process. Typical criteria are the final destination, shipment,

or load. After a product arrives, it's distributed to each sort position, based on the quantity that is associated with

the order, destination, shipment, or load. When a container is full or complete, it's moved to a staging location or

a shipping location for further handling, depending on the business process.

This warehousing functionality is also referred to by other names, such as put-to-light and break opens.

Before you can use the Put to wall - put to store functionality, the Outbound sorting feature must be turned on

in your system. Admins can use the Feature management workspace to check the status of the feature and turn

it on if it's required. There, the feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Outbound sorting

The Outbound sorting feature can be used in conjunction with the Organization wide wave step code feature if

it's turned on. You must also turn on this feature if you will use predefined codes that are set up in wave step

codes. In the Feature managementFeature management workspace, this feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Organization wide wave step code

For this demo, standard Contoso data and warehouse 62 are used. Some additions that are noted later are also

used.

1. Go to Warehouse management > Setup > Warehouse > Location typesWarehouse management > Setup > Warehouse > Location types .

2. On the Action Pane, select NewNew  to create a location type for sorting.

3. Set the following values:

Location type:Location type: SORT

Descr iption:Descr iption: Sort

4. Select SaveSave.

1. Go to Warehouse management > Setup > Warehouse management parametersWarehouse management > Setup > Warehouse management parameters .

2. On the GeneralGeneral  tab, on the Location typesLocation types  FastTab, in the Sor ting location typeSor ting location type field, enter SORT.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/put-to-wall-put-to-store.md


Location profileLocation profile

LocationsLocations

Packing profilesPacking profiles

Wave step codesWave step codes

3. Select SaveSave.

1. Go to Warehouse management > Setup > Warehouse > Location profilesWarehouse management > Setup > Warehouse > Location profiles .

2. On the Action Pane, select NewNew  to create a location profile for the sorting location.

3. In the header, set the following values:

Location profile ID:Location profile ID: Sort

Name:Name: Sort

4. On the GeneralGeneral  FastTab, set the following values:

Location format:Location format: PACK

Location type:Location type: SORT

Use license plate tracking:Use license plate tracking: Yes

Allow mixed items:Allow mixed items: Yes

Allow mixed inventor y statuses:Allow mixed inventor y statuses: Yes

5. Select SaveSave.

1. Go to Warehouse management > Setup > Warehouse > LocationsWarehouse management > Setup > Warehouse > Locations .

2. Clear the Generate check digits for locationGenerate check digits for location check box.

3. On the Action Pane, select NewNew , and then set the following values:

Warehouse:Warehouse: 62

Location:Location: Sort

Location profile ID:Location profile ID: Sort

4. Select SaveSave.

1. Go to Warehouse management > Setup > Packing > Packing profilesWarehouse management > Setup > Packing > Packing profiles .

2. On the Action Pane, select NewNew , and then set the following values:

Packing profile ID:Packing profile ID: Sort

Descr iption:Descr iption: Sort

Container packing policy:Container packing policy: Leave this field blank.

Container ID mode:Container ID mode: Auto

Container type:Container type: PALLET 48X48

Autocreate container at container close:Autocreate container at container close: Leave this field blank.

3. Select SaveSave.

If you turned on the Organization wide wave step code feature, set up the following code.

1. Go to Warehouse management > Setup > Waves > Wave step codesWarehouse management > Setup > Waves > Wave step codes .

2. On the Action Pane, select NewNew , and then set the following values:

Wave step code:Wave step code: Sort

Wave step descr iption:Wave step descr iption: Sort

Wave step type:Wave step type: Sort template

3. Select SaveSave.



Outbound sorting templateOutbound sorting template
The sorting template controls whether sort positions are created, what criteria are used, and other attributes of

the sorting process.

1. Go to Warehouse management > Setup > Packing > Outbound sor ting templateWarehouse management > Setup > Packing > Outbound sor ting template.

2. On the Action Pane, select NewNew  to create a sorting template.

3. In the header of the new template, set the following values:

Outbound sor ting template ID:Outbound sor ting template ID: Wave Sort

Descr iption:Descr iption: Wave sort

Sor t template type:Sor t template type: Wave demand

This field defines the process that the sorting template is used for. The following values are

available:

Wave demandWave demand – The sorting template is used for the Put to wall process. This template type is

used to bypass the pack station and process inventory directly out of the wave. You can use this

type only if the sor tingsor ting wave process method is included in the wave template.

ContainerContainer  – The sorting template is used for the Pallet building after packing process. This

template type is used to process containers that are closed at the pack station and must be

sorted onto pallets.

Warehouse:Warehouse: 62

Location:Location: Sort

4. On the GeneralGeneral  FastTab, set the following values:

Sor t ver ification:Sor t ver ification: Position scan

This field defines the verification that is required during sorting. The following values are available:

None

License plate scan

Position scan

Create work on position close:Create work on position close: Yes

If this option is set to Yes, when the position is closed, work will be created to move inventory to

the final shipping location. If it's set to No, inventory will immediately be picked to the order when

the position is closed.

Position assignment:Position assignment: Manual

This field defines the type of position assignment. The following values are available:

ManualManual  – The user must always indicate which position the inventory should be sorted to.

AutomaticAutomatic – The system will automatically guide the inventory to a position whenever it can,

based on the sort template breaks.

Assign sor t position cr iter ia:Assign sor t position cr iter ia: Only use empty position

This field controls whether inventory that is already present on sort positions is taken into account

when a position is assigned for the demand. The following values are available:

Only use empty positionOnly use empty position – Positions that already have inventory associated with them will

be taken into account

Assume position emptyAssume position empty  – Any inventory that is already on the position will be disregarded



Wave process methodsWave process methods

Wave templatesWave templates

during assignment. All available positions will be used.

Wave step code:Wave step code: Sort

If the Organization wide wave step code feature is turned on, the Sort wave step code must also be

set up in wave step codes.

Auto close sor t position:Auto close sor t position: Yes

If this option is set to Yes, the sort position will automatically be closed when all work that comes

to the position has been completed.

Number of sor t positions:Number of sor t positions: 3

This field defines the maximum number of sort positions that the system will create.

Sor t position prefix:Sor t position prefix: SP-

This field defines the prefix that the system assigns before the position number.

Auto pack sor t position:Auto pack sor t position: Yes

If this option is set to Yes, the inventory on the sort position will be packed into a container when

the position is closed.

Packing profile ID:Packing profile ID: Sort

This field defines the packing profile that will be used when the sort position is packed into a

container.

5. On the Action Pane, select Edit quer yEdit quer y  to specify the criteria that are used for this sorting template.

6. In the query dialog box, on the Sor tingSor ting tab, select NewNew  to add a line, and then set the following values:

Table:Table: Load details

Derived table:Derived table: Load details

Field:Field: Shipment ID

Search direction:Search direction: Ascending

7. Select OKOK.

8. You might receive the following message: "Grouping will be reset, continue?" Select YesYes .

The Outbound sor ting template breaksOutbound sor ting template breaks  button on the Action Pane becomes available.

9. On the Action Pane, select Outbound sor ting template breaksOutbound sor ting template breaks .

10. Select the Group by fieldGroup by field check box to group by shipment ID.

This setting will create one sort position per shipment that is a container in the wave.

11. Select OKOK.

1. Go to Warehouse management > Setup > Waves > Wave process methodsWarehouse management > Setup > Waves > Wave process methods .

2. On the Action Pane, select Regenerate methodsRegenerate methods .

The sor tingsor ting method is added to the list of available methods, and the Shipping wave template type is

selected for it.

Edit the wave template that is used for wave demand sorting.



Mobile device menu itemsMobile device menu items

Mobile device menuMobile device menu

Location directivesLocation directives

1. Go to Warehouse management > Setup > Waves > Wave templatesWarehouse management > Setup > Waves > Wave templates .

2. In the Wave template typeWave template type field, select Shipping.

3. Select the existing 62 Shipping default62 Shipping default template.

4. On the Action Pane, select EditEdit.

5. On the GeneralGeneral  FastTab, make the following changes:

Set the Process wave at release to warehouseProcess wave at release to warehouse option to No.

Set the Assign to open wavesAssign to open waves  option to Yes.

6. On the MethodsMethods  FastTab, set up the sor tingsor ting method:

a. In the Remaining MethodsRemaining Methods  grid, select sor tingsor ting.

b. Select the right arrow button to move sor tingsor ting to the Selected MethodsSelected Methods  grid.

c. In the Selected MethodsSelected Methods  grid, select sor tingsor ting.

d. Set the Wave step codeWave step code field to Sort.

7. Select SaveSave.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. On the Action Pane, select NewNew .

3. In the header, set the following values:

Menu item name:Menu item name: Sort

Title:Title: Sort

Mode:Mode: Indirect

Use existing work :Use existing work : No

4. On the GeneralGeneral  FastTab, set the following values:

Activity code:Activity code: Outbound sorting

Use process guide:Use process guide: Yes (default value)

Outbound sor ting template ID:Outbound sor ting template ID: Wave Sort

5. Select SaveSave.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menuWarehouse management > Setup > Mobile device > Mobile device menu.

2. In the list of menus, select OutboundOutbound.

3. On the Action Pane, select EditEdit.

4. In the Available Menus And Menu ItemsAvailable Menus And Menu Items grid, find and select the Sor tSor t menu item that you just created.

5. Select the right arrow button to move Sor tSor t to the Menu StructureMenu Structure grid. In this way, you add the menu item

to the OutboundOutbound menu.

6. Select SaveSave.

You must create location directives to guide the work that is created after the sorting is completed.

1. Go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives .

2. In the Work order typeWork order type field, select Sorted inventory picking.

3. On the Action Pane, select NewNew .



Work classesWork classes

Work templatesWork templates

4. In the header, set the following values:

Sequence:Sequence: 1

Name:Name: Put to Baydoor

5. On the Location directivesLocation directives  FastTab, set the following values:

Work type:Work type: Put

Site:S ite: 6

Warehouse:Warehouse: 62

Directive code:Directive code: Leave this field blank.

Multiple SKU:Multiple SKU: No

6. Select SaveSave to make the L inesLines  FastTab available.

7. On the L inesLines  FastTab, select NewNew , and then set the following values. Accept the default values for all the

other fields.

Sequence number :Sequence number : 1

From quantity:From quantity: 0

To quantity:To quantity: 1000000

8. Select SaveSave to make the Location Directive ActionsLocation Directive Actions  FastTab available.

9. On the Location Directive ActionsLocation Directive Actions  FastTab, select NewNew , and then set the following values. Accept the

default values for all the other fields.

Sequence number :Sequence number : 1

Name:Name: Baydoor

10. Select SaveSave to make the Edit quer yEdit quer y  button on the Location Directive ActionsLocation Directive Actions  FastTab available.

11. On the Location Directive ActionsLocation Directive Actions  FastTab, select Edit quer yEdit quer y .

12. In the query dialog box, on the RangeRange tab, find the row where the FieldField field is set to Location. Set the

Criter iaCriter ia field for this row to Baydoor.

13. Select OKOK to confirm the edit.

1. Go to Warehouse management > Setup > Work > Work classesWarehouse management > Setup > Work > Work classes .

2. On the Action Pane, select NewNew .

3. In the header, set the following values:

Work class ID:Work class ID: Sorting

Descr iption:Descr iption: Sorting

Work order type:Work order type: Sorted inventory picking

4. Select SaveSave.

1. Go to Warehouse management > Work > Work templatesWarehouse management > Work > Work templates .

2. In the Work order typeWork order type field, select Sales orders.

3. In the grid, select the 62 Pick to pack62 Pick to pack work template.

4. On the Action Pane, select Work header breaksWork header breaks .

5. On the Action Pane, select EditEdit.



Example scenario

Create demandCreate demand

6. On the line where the Field nameField name field is set to Shipment ID, clear the Group by this fieldGroup by this field check box.

7. Select SaveSave, and then close the Work header breaksWork header breaks  dialog box.

8. In the Work order typeWork order type field, select Sorted inventory picking.

9. Select NewNew  to create a work template.

10. In the Over viewOver view  section, set the following values. Accept the default values for all the other fields.

Work template:Work template: Sorted picking

Work template descr iption:Work template descr iption: Sorted picking

11. Select SaveSave to make the Work Template DetailsWork Template Details  section available.

12. In the Work Template DetailsWork Template Details  section, you will create two lines. Select NewNew , and then set the following

values for line 1:

Work type:Work type: Pick

Mandator y:Mandator y: Selected (= Yes)

Work class ID:Work class ID: Sorting

13. Select NewNew  again, and then set the following values for line 2:

Work type:Work type: Put

Mandator y:Mandator y: Selected (= Yes)

Work class ID:Work class ID: Sorting

14. Select SaveSave.

This scenario simulates a situation where the warehouse stores small items in locations and must pack them

into boxes before they are shipped, and where packing station functionality isn't really suitable. Workers pick

orders for multiple customers and different addresses at the same time to increase the picking speed. After

picking has been completed, the workers arrive at the sorting location, where the picked items can be sorted to

the correct box, based on required criteria. In this example, the shipment ID will be used to determine the correct

box, because each shipment has a different address. After all items from the load are packed and sorted by

shipment, the boxes will be moved to the staging area and eventually loaded onto a truck.

Before you start the scenario, make sure that all standard warehouse functionality is set up correctly for your

warehouse. Standard Contoso warehouse 62 is used for this purpose. Standard configurations haven't been

changed, besides what is described in the setup.

Before the functionality can be demonstrated, you must create some demand. For this scenario, you will create

three sales orders for three different customers to simulate different delivery addresses. In this way, you will

create three separate shipments.

Before you create sales orders and shipments, make sure that the pick locations have enough inventory for all

the items on the orders. Review the location directive settings to confirm the picking locations that are used for

sales order picking. If you must adjust the inventory, you can create manual movements, use replenishment, or

use any other flow. Then reserve the inventory.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. Select NewNew  to create a sales order for order 1.

3. In the Create sales orderCreate sales order  dialog box, set the following values:



Customer :Customer : US-001

Warehouse:Warehouse: 62

4. Select OKOK.

5. A new line is added to the Sales order linesSales order lines  FastTab. Set the following values:

Item number :Item number : A0001

Quantity:Quantity: 5

6. Select Add lineAdd line to add a second line, and set the following values:

Item number :Item number : A0002

Quantity:Quantity: 10

7. Repeat the following steps for each sales line on the order to reserve inventory for it:

a. On the Sales order linesSales order lines  FastTab, on the Inventor yInventor y  menu, select Reser vationReser vation.

b. On the Reser vationReser vation page, select Reser ve lotReser ve lot, and then close the page.

c. Select SaveSave.

8. Select NewNew  to create a sales order for order 2.

9. In the Create sales orderCreate sales order  dialog box, set the following values:

Customer :Customer : US-004

Warehouse:Warehouse: 62

10. Select OKOK.

11. A new line is added to the Sales order linesSales order lines  FastTab. Set the following values:

Item number :Item number : A0001

Quantity:Quantity: 7

12. Select Add lineAdd line to add a second line, and set the following values:

Item number :Item number : A0002

Quantity:Quantity: 3

13. Repeat the following steps for each sales line on the order to reserve inventory for it:

a. On the Sales order linesSales order lines  FastTab, on the Inventor yInventor y  menu, select Reser vationReser vation.

b. On the Reser vationReser vation page, select Reser ve lotReser ve lot, and then close the page.

c. Select SaveSave.

14. Select NewNew  to create a sales order for order 3.

15. In the Create sales orderCreate sales order  dialog box, set the following values:

Customer :Customer : US-007

Warehouse:Warehouse: 62

16. Select OKOK.

17. A new line is added to the Sales order linesSales order lines  FastTab. Set the following values:

Item number :Item number : A0001

Quantity:Quantity: 8

18. Follow these steps to reserve inventory for the sales line:

a. On the Sales order linesSales order lines  FastTab, on the Inventor yInventor y  menu, select Reser vationReser vation.

b. On the Reser vationReser vation page, select Reser ve lotReser ve lot, and then close the page.

c. Select SaveSave.



Sales order picking to the sorting locationSales order picking to the sorting location

Complete the following procedure to release each sales order to the warehouse. Three different shipments will

be created. You will then add all three shipments to one new wave.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. In the grid, select the first sales order that you created.

3. On the Action Pane, on the WarehouseWarehouse tab, select Release to warehouseRelease to warehouse.

You receive an informational message that shows the wave ID and shipment ID that were created.

4. Repeat the previous steps to release sales orders 2 and 3 to the warehouse. Notice that the informational

message that you receive indicates that a shipment has been added to the wave that was created when

you released sales order 1.

5. Go to Warehouse management > Outbound waves > Shipment waves > All wavesWarehouse management > Outbound waves > Shipment waves > All waves .

6. Select the wave ID that was created from the release of the sales orders to open the WavesWaves  page. This

page shows the wave details. The Wave linesWave lines  FastTab shows the shipments that were created.

You must now create work to bring items from the picking locations to the sorting location.

7. On the Action Pane, select ProcessProcess .

During wave processing, the sorting method will use the sorting template to assign the inventory to sort

positions. When wave processing is completed, you receive an informational message that states that the

wave has been posted and work has been created.

8. On the Action Pane, on the WaveWave tab, in the Related informationRelated information group, select WorkWork to view the work

that was created. Make a note of the work ID.

9. Go to Warehouse management > Packing and container ization > Outbound sor ting positionWarehouse management > Packing and container ization > Outbound sor ting position

assignmentsassignments .

10. In the left column, you can view the outbound sorting position that was created for each shipment.

11. On the Sor t position cr iter iaSor t position cr iter ia FastTab, you can view the shipment ID for that position.

One work ID has been created to bring inventory from the picking locations to the sorting location. To complete

the work, you will need the work ID that was created during wave processing.

1. Sign in to the mobile app as a worker in warehouse 62.

2. On the main menu, select OutboundOutbound.

3. On the OutboundOutbound menu, select Sales PickingSales Picking.

4. Select the IDID field, and then enter the work ID from the wave processing.

5. Confirm your entry.

Next, you're prompted to enter a target license plate (LP). Notice that line 1 from sales order 1 is what

must be picked and added to the target license plate. The item number, quantity, item description, and

pick location are shown.

6. In the Target LPTarget LP field, enter a license plate number.

You will pick all lines that were created from the processed wave onto the same target license plate.

7. Confirm your entry.

The mobile app now presents a series of PickPick pages that point you to the picking location, and to the



Sorting/put-to-wallSorting/put-to-wall

item and quantity that must be picked. After the picked item is added to the license plate, you will confirm

the pick work. The last page will be the work to put the picked items into the sorting location.

8. Confirm the first pick work.

9. The next pick work is shown. Confirm the pick.

10. Continue to confirm the remaining pick work.

11. The last step is to complete the put work. Confirm the put-away to the sorting location.

You receive a "Work completed" message.

12. Exit Sales PickingSales Picking on the mobile app.

Now that all inventory has been put to the sorting location, it must be sorted to the correct sort position.

NOTENOTE

1. Sign in to the mobile app.

2. On the main menu, select OutboundOutbound.

3. On the OutboundOutbound menu, select Sor tSor t to start to sort the items.

4. In the LP/CONLP/CON field, enter the target license plate of the picked sales order work.

5. Confirm your entry.

6. Enter the item number to sort first.

7. The system determines the first sort position that should be shown. Confirm the sort position.

8. You're prompted to assign a license plate to the sort position. Select the LPLP field, enter a license plate

number, and then confirm your entry.

Because the sort position is related to the shipment ID, you will sort the picked items into a license plate

that is specific to the outbound shipment and sales order.

The next page shows the item ID, quantity, sort position ID, and the "from" (picking) and "to" (sorting)

license plate IDs. The information on this page instructs you to sort the specified item and quantities from

the picking license plate into the sorting license plate.

9. Confirm the sort position.

10. Sort the items in the first sort position. When you've finished, the system directs you to the next sort

position.

11. Repeat this process for all picked lines on the work order. You should also use this process when there are

multiple pick lines that have the same item number.

As you repeat this process for all items, the system evaluates the criteria from the next scanned item

(work line) and determines which sorting position it should be put to. You're automatically directed to put

the item to the correct sort position. Depending on the confirmation setup, you're also directed to confirm

this action by entering the position number or license plate ID.

If automatic sorting is turned on, manual override isn't available.

12. When you've finished, in Microsoft Dynamics 365 Supply Chain Management, open the OutboundOutbound

sor ting position assignmentssor ting position assignments  page to review the status of the positions.



NOTENOTE

Manually close a position (optional)Manually close a position (optional)

Tips

IMPORTANTIMPORTANT

NOTENOTE

If positions are closed automatically, select Show closedShow closed to show the closed positions.

Notice that sort position transactions are shown. The item and quantity that were processed through

the position are shown.

When you set up the outbound sorting template, you set the Auto close sor t positionAuto close sor t position option to Yes.

Therefore, the position is automatically closed after the last expected inventory is put to it. The sort

positions are in ClosedClosed status, and work has been created to move the sorted inventory to Baydoor

location.

13. Complete the sorted inventory picking work to move the inventory to the shipping location. When the

inventory is ready, ship-confirm it.

For sorted inventory picking work to be processed correctly, a mobile device menu item that has a work class ID where

the Work order typeWork order type field is set to Sorted inventory picking should be used for the movement and loading process.

If sort positions should be closed manually, the Auto close sor t positionAuto close sor t position option for the outbound sorting

template must be set to No, and closing must be done before inventory can be moved to the bay door area.

Positions can be closed in various ways:

Via the warehouse app:

The user can scan one of the items that are already on the position and then select CloseClose to close the

position.

If the user scans a container that has already been sorted container, an error message is shown.

However, the user can still continue to close the position.

From the Microsoft Dynamics 365 Supply Chain Management Outbound sor ting positionOutbound sor ting position

assignmentsassignments  page:

The user can select the outbound sorting position record and then select Close positionClose position on the

Action Pane.

Items can't be moved between positions after they have been assigned to one. The system evaluates how

many of each item should go to a specific position.

Sorts template can be configured to automatically create containers when positions are closed. This

approach will create standard container ID structure that is based on the specified packing profile.

After movement work has been created from the sorting location, you must not cancel the work. Otherwise, the position

and the containers in it will be deleted from the system and unavailable for further processing. The inventory will also be

removed.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Outbound workload visualization
2/18/2021 • 5 minutes to read • Edit Online

Turn on the Outbound workload visualization feature

Set up outbound workload visualizations

Advanced setup capabilities that are accessible from the Outbound workload visualizationOutbound workload visualization page let

warehouse managers and supervisors create custom workload charts that can be used to monitor the progress

of current work and the amount of it that remains. Warehouse managers can create multiple views and set up

automatic refresh as they require. Outbound workload visualizations are suitable for display on warehouse

performance pages.

This functionality can be used to track the progress of picking work. The feature is integrated with labor

management, and if labor management is set up, outbound workload visualizations can show a calculation of

the number of hours that remain for the picking work that is shown (filtered).

Before you can use this feature, it must be turned on in your system. Admins can use the Feature management

settings to check the status of the feature and turn it on. In the Feature managementFeature management workspace, the feature is

listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Outbound workload visualization

To set up your visualizations, you create a collection of filters (views) and design each filter so that it shows a

different type of analysis. You use the Configure filtersConfigure filters  page to design the filters.

To set up an outbound workload visualization, follow these steps.

1. Go to Warehouse management > Warehouse monitor ing repor ts > Outbound workloadWarehouse management > Warehouse monitor ing repor ts > Outbound workload

visualizationvisualization.

The Outbound workload visualizationOutbound workload visualization page appears. After you create some filters, this page will show

your visualization. You can create as many filters as you want. All the filters that you create are saved

under your user account, so that you can use them later. In other words, each user will have their own set

of filters that they created. Those filters won't be shared with other users.

2. On the Outbound workload visualizationOutbound workload visualization page, on the Action Pane, on the FiltersFilters  tab, select

Configure filtersConfigure filters .

3. On the Configure filtersConfigure filters  page, on the Action Pane, select NewNew  to add a filter, and then set the following

fields for it:

X-axis group tableX-axis group table – Select the table that contains the field that should be used to group the X-axis

values.

X-axis group fieldX-axis group field – From among the fields of the table that you selected in the X-axis group tableX-axis group table

field, select the field that should be used to group the X-axis values.

X-axis value tableX-axis value table – Select the table that contains the field that should be used to further analyze the

groups.

X-axis value fieldX-axis value field – From among the fields of the table that you selected in the X-axis value tableX-axis value table

field, select the field that provides the values that should be analyzed for each group.

Auto-refreshAuto-refresh – Select whether the visualization should automatically be refreshed.
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Refresh inter val (minutes)Refresh inter val (minutes)  – Enter the number of minutes between automatic refreshes.

Display levelDisplay level  – Select whether the chart should show open lines or open header counts.

Picking typePicking type – If you set the Display levelDisplay level  field to Open lines, select whether the count of open

work lines in the chart should include initial picks, staged picks, or both initial picks and staged picks.

S iteSite – Select the site to load the chart for.

WarehouseWarehouse – Select the warehouse to load the chart for.

Days to includeDays to include – Enter the number of days in the past that the chart should be generated for.

Work order typeWork order type – Select the outbound work order types to filter on.

4. Close the Configure filtersConfigure filters  page to return to the Outbound workload visualizationsOutbound workload visualizations  page.

The Outbound workload visualizationsOutbound workload visualizations  page now shows data, based on your new filter settings. Your

new filter is now available and is selected in the FilterFilter  field. The following fields are available at the top of

the chart:

FilterFilter  – This field includes all the filters that you've created so far. Select a filter to view its data in the

chart.

Last refreshedLast refreshed – This field shows the date and time when the information in the chart was last

updated.

Estimated/actual timeEstimated/actual time – If labor standards are set up in your system, set this option to Yes to show

accumulated estimated picking times at the top of each column in the chart. If you aren't using labor

standards, this option is unavailable.



Example: Outbound workload visualization for zones

5. Select any bar in the chart to view the associated work line details.

For this example, you want to set up a visualization that shows work lines for each zone, and the status of each

work line (Open, Closed, or Canceled). In this case, you can set up a filter that has the following settings:

Filter  nameFilter  name – Enter a name for this filter (such as Zone vs. work status).

Descr iptionDescr iption – Enter a short description for this filter (such as Zone vs. work status).

X-axis group tableX-axis group table – Select Locations.

X-axis groupX-axis group – Select Zone ID.

X-axis value tableX-axis value table – Select Work, because you want to view work per zone.

X-axis value fieldX-axis value field – Select Work status, because you want to view work status.

Auto refreshAuto refresh – Select whether the visualization should automatically be refreshed.

Picking typePicking type – Select Initial picks and staged picks, because you want to include both initial picks and picks

from staging locations. In other words, you essentially want to include all the pick work lines that you have.

Display levelDisplay level  – Select Open lines, because you want to view the information per line, not per work header.

The following illustration shows an example of the resulting chart.



NOTENOTE

This chart shows two zones that are named FLOORFLOOR and BULKBULK, plus a zone that is named BlankBlank . The BlankBlank

zone represents all work lines that aren't members of any zones. The chart always shows all unrelated filtered

data as BlankBlank , to provide as much visibility as possible. In the FLOORFLOOR zone, the chart shows three closed lines

and four open lines. In the BULKBULK zone, the chart shows four closed lines, one open line, and 24 canceled lines.

Finally, the chart shows eight closed lines that aren't part of any zone and are therefore listed as BlankBlank .

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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I receive the following error message: "Dimension location can't be
left blank if dimension serial number is set."
Issue descriptionIssue description

Issue resolutionIssue resolution

I receive the following error message: "Invalid license plate."
Issue descriptionIssue description

Issue resolutionIssue resolution

I receive the following error message: "Field 'Load weight'(=-%1) can
only contain positive numbers. Update has been canceled."
Issue descriptionIssue description

Issue resolutionIssue resolution

I receive the following error message: "The quantity is not valid for
unit %1."
Issue descriptionIssue description

Issue resolutionIssue resolution

This topic describes how to fix common issues that you might encounter while you pick and pack in Microsoft

Dynamics 365 Supply Chain Management.

You receive this error message if you create a transfer order for a serial item by using a warehouse that is

enabled for advanced warehouse management (WMS), and then, after the work is completed, you try to confirm

the shipment.

The Default receipt locationDefault receipt location field is blank for a transit warehouse of the "from" warehouse. To fix this issue,

specify a default receipt location in the transit warehouse. Make sure that this location is license plate–

controlled.

You receive this error message in the warehouse app when you scan a license plate ID.

Make sure that the license plate ID exists in the license plates table, and that the items and quantities on the

license plate are available (in other words, they aren't blocked).

You receive this error message if there is open work when you process work from packing locations to staging

locations, or from staging locations to dock locations.

To fix this issue, go to System administration > Periodic tasks > Database > Consistency checkSystem administration > Periodic tasks > Database > Consistency check , and

run the process for Warehouse load weight consistency checkWarehouse load weight consistency check .

You receive this error message when you try to perform a split pick across multiple batches.

The warehouse worker must use the Short picking process in the warehouse app. If you're trying to pick

multiple batches from the same location, you can also use the FullFull  option in the warehouse app.
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I can't move inventory to a location that is license plate–controlled.
Issue descriptionIssue description

Issue resolutionIssue resolution

Can I print a delivery note or packing content by warehouse?
Issue descriptionIssue description

Issue resolutionIssue resolution

I can't cancel a packing slip after it's posted from a sales order.
Issue descriptionIssue description

Issue resolutionIssue resolution

I receive the following error message: "Not enough work can be
found for cluster."
Issue descriptionIssue description

Issue resolutionIssue resolution

NOTENOTE

You can't reduce picked quantities on a load.

In earlier versions, you can't reduce picked quantities on a load. However, you can now unpick to a license plate–

controlled location. You must specify both a LocationLocation value and a L icense plateLicense plate value for the load line on the

Reduce picked quantityReduce picked quantity  page.

You want to print a delivery note or packing content by warehouse or site on the Work audit template lineWork audit template line

updateupdate page.

When you print a document by using Print management settings, limit the scope (site/warehouse) through Print

management instead of by selecting Edit pr int settingsEdit pr int settings  on the Work audit template line updateWork audit template line update page.

When picking and shipping processes are enabled for WMS, you can't cancel a packing slip after it's posted from

a sales order.

To correct posted packing slips for items that are enabled for WMS, the posting must occur from the load, not

from the order. Microsoft has evaluated this issue and has determined that it's a feature limitation. In general, a

sales order that has been picked and shipped through warehouse management processes can be packing slip–

updated from the load or shipment and the sales order document itself. However, if you packing slip–update the

sales order from the sales order document, packing slip reversal still can't be done from the load or sales order.

Therefore, we recommend that you use the packing slip posting from the load. In this case, the reversal that

must be done from the load will be enabled.

When you use the System directed cluster picking process, if you configure a cluster profile where, for example,

10 positions can be picked, the process works as planned when there is enough work to pick to 10 positions.

However, if there are only eight positions to pick, you receive this error message, because there isn't enough

work for one cluster.

To fix this issue, edit the cluster profile, and set the Activate positionsActivate positions  option to No.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Wave demand replenishment

This topic describes the replenishment strategies that are available for warehouses that use the functionality that

is available in Warehouse management. The information in this topic doesn't apply to the warehousing solution

that is available in Inventory management.

The following replenishment strategies are available:

Wave demand replenishmentWave demand replenishment – This strategy creates replenishment work for outbound orders or loads if

inventory isn't available when the wave creates work. For example, replenishment work can be created if the

quantity that is required for a sales order isn't available when a wave is processed.

Min/Max replenishmentMin/Max replenishment – This strategy uses minimum and maximum stocking limits to determine when

locations should be replenished. The item and location criteria define the inventory that is evaluated for

replenishment. Min/Max replenishment templates are the primary mechanism for maintaining optimal levels

in picking locations. To help guarantee that enough pick face inventory is available to meet wave demand,

you can use demand replenishment as a supplement between Min/Max replenishment cycles.

Load demand replenishmentLoad demand replenishment – This strategy sums the demand for several loads and creates the

replenishment work that is required in order to stock the relevant picking locations. This strategy helps

guarantee that the loads that are created can be picked in the warehouse after they are released.

Immediate replenishmentImmediate replenishment – This strategy replenishes inventory before a wave is run if allocation fails for

a location directive line that has a replenishment template.

All four strategies create replenishment work, based on a replenishment template.

Wave demand replenishment creates replenishment work, based on demand, if the quantity that is required for

production orders, kanbans, outbound orders, or loads isn't available when a wave creates work. The

replenishment template contains information about the item criteria, the unit of measure, the demand

increment, and the location.

Location directives are used to determine which location should be replenished. You link these location

directives to the replenishment template by using the Directive codeDirective code field. If the Directive codeDirective code field isn't set,

queries are used to determine which location directive should be used. Note that if a directive code isn't

specified in the replenishment template, and the location directive has a directive code, the location directive will

be ignored, even if the query on the location directive is correct. Pick location directives are used to determine

where to get inventory for the replenishment.

In addition to creating a template, you must specify some replenishment settings in the wave template. The

wave template should contain a wave step for replenishment that is run only if an item isn't successfully

allocated. This replenishment wave step uses a wave step code to determine which replenishment template

should be used. In addition to having a wave step for replenishment, you must make sure that ReplenishReplenish is

selected in the MethodsMethods  section of the wave template.

The Replenishment templateReplenishment template page includes an Allow wave demand to use unreser ved quantitiesAllow wave demand to use unreser ved quantities  check

box. Select this check box if demand replenishment should be able to deduct unreserved quantities from work

that is generated from the selected replenishment template. To enable demand replenishment templates to use

this logic, select this check box for every existing replenishment template. When demand replenishment is

triggered in the warehouse, it will deduct the demand from existing replenishment work that has unreserved

quantities, if the work originates from replenishment templates where the Allow wave demand to useAllow wave demand to use
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Min/Max replenishment

Load demand replenishment

Immediate replenishment

Replenishment prerequisites

P REREQ UISIT EP REREQ UISIT E DESC RIP T IO NDESC RIP T IO N

Item The item must be enabled for warehouse management
processes.

Warehouse The warehouse must be enabled for warehouse
management processes. To enable a warehouse for
warehouse management processes, on the WarehousesWarehouses
page, select the warehouse, and then select the UseUse
warehouse management processeswarehouse management processes option.

unreser ved quantitiesunreser ved quantities  check box is selected.

Replenishment unitReplenishment unit is the minimum unit to replenish. This must be a whole number that is a multiple of the

unit. The system will round up to the highest unit possible when creating work.

Demand replenishment is supported for sales orders, transfer orders, production orders, and kanbans.

In Min/Max replenishment, stock is replenished so that it's between the minimum and maximum limits that have

been set. Typically, this process occurs one time every day, to help guarantee that all picking locations are filled

to the maximum level before picking starts.

The minimum and maximum amounts are set in a replenishment template. Many of the other settings in the

template resemble the settings in templates that are used in Wave demand replenishment. The template should

contain one line for each item and location. When you run replenishment by using the batch job, the system

evaluates whether replenishment is required by using the sequence that the lines are organized in.

Note that the Min/Max replenishment strategy can't replenish an empty location unless the location is set as the

fixed location for the item. If the location that must be replenished isn't a fixed location, the system can't

determine which item should be replenished. Therefore, at least some on-hand quantity is required before

replenishment occurs.

Load demand replenishment sums the demand for several loads and creates the replenishment work that is

required in order to stock the relevant picking locations. Load demand replenishment resembles Wave demand

replenishment in many ways. The main difference is how and when Load demand replenishment and Wave

demand replenishment are run. Like Min/Max replenishment, Load demand replenishment is run by using a

batch job. To set up the batch job, on the Load demand replenishmentLoad demand replenishment page, select the replenishment

template to use, and set a filter query to specify which loads are used to determine the demand. The location

query defines the locations that any available quantity will be subtracted from to meet the aggregated demand

of the loads.

Instead of having to sum demand at the end of an allocation process and do replenishment on the basis of the

summed up quantity, you can apply the Immediate replenishment strategy. When you use this strategy, the

inventory can be replenished immediately after a location directive line fails. Therefore, you can set up the

replenishment so that it's restricted by specific units, and so that it uses quantities that are set for specific

locations.



Replenishment templates At least one replenishment template must be set up for
Min/Max replenishment, Wave demand replenishment, or
Load demand replenishment.

Locations Locations must be created and connected to a location
profile.

Location profiles Location profiles are required in order to create locations.

Location directives Location directives are required in order to guide work to
the locations where replenishment is required and to the
locations that inventory is sourced from.

Work templates Work templates of the ReplenishmentReplenishment  type are required in
order to create replenishment work so that inventory can be
moved to the desired locations.

P REREQ UISIT EP REREQ UISIT E DESC RIP T IO NDESC RIP T IO N
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Business scenario

Where it applies

Set up immediate replenishment

Troubleshooting

Immediate replenishment lets you replenish inventory immediately after a location directive line fails to allocate

inventory. The replenishment is based on a single line in the setup of the location directive. If inventory isn't on

hand in the unit of measure that is specified by that line, replenishment of that unit of measure occurs

immediately.

Immediate replenishment provides an alternative to the method where the allocation of inventory is based on

more lines in the location directive, and where the demand is summed at the end of the allocation and

replenished in the unit of measure that is specified by the last line in the location directive.

The benefits of using immediate replenishment are that replenishment can be limited by specific units and the

quantity can be directed to specific locations.

For example, you have a warehouse that has separate picking areas for the "box" and "each" units of measure.

You want to optimize the picking process by picking as many boxes as possible and then picking any remaining

quantity that is less than a box from the "each" area.

In this case, you can use immediate replenishment. In the location directive, you can set up immediate

replenishment for boxes so that demand replenishment is used as soon as there is a shortage of boxes that can

be picked for the demand quantity. In this way, you optimize the picking process so that picking includes as

many boxes as possible. Immediate replenishment will generate replenishment of the boxes, and the demand

won't be passed on so that the quantities are picked in the "each" unit of measure. In other words, only the

quantities that are supposed to be picked in the "each" unit of measure (that is, quantities that are less than a

box) will be picked from the "each" area. If a shortage occurs in the "box" area, you can pick as many boxes as

possible out of the total demand. The remaining quantities will then be picked from the "each" area.

Immediate replenishment is used during wave execution if allocation fails for a location directive line that a

replenishment template is set for.

Go to Warehouse managementWarehouse management > SetupSetup > Location directivesLocation directives , and then, on the L inesLines  tab, in the

Immediate replenishment templateImmediate replenishment template list, select a replenishment template for wave demand.

The replenishment template is applied if the location directive line fails to allocate a dedicated unit of measure.

If immediate replenishment is selected for a location directive line, but no replenishment work is generated

when you use demand replenishment templates for that location directive line, two main causes must be

investigated:

Make sure that the demand replenishment template that is applied is set up to use the correct location

templates and work templates of the ReplenishmentReplenishment type.

Make sure that there is enough on-hand inventory at the locations where the demand replenishment
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NOTENOTE

template searches for on-hand inventory for replenishment.
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Workflow for material replenishment that uses the withdrawal kanban

Configure warehouse work for kanban picking for the withdrawal

This topic describes how the withdrawal kanban is used for material replenishment for manufacturing activities.

The withdrawal kanban can be used to move a kanban of a single item between warehouses and production

locations where the material is consumed. The withdrawal kanban supports a pull-based solution for material

replenishment, where a pull signal is required in order to trigger supply for a specific demand.

The following scenario shows a pull-based replenishment system where a pull signal triggers the creation of a

kanban to replenish material for a production process.

1. Withdrawal kanban

2. Kanban “from” location and put location for warehouse work

3. Kanban “to” location and production input location

4. Manufacturing process

5. Warehouse work for kanban picking

6. Warehouse locations for raw material

7. Material warehouse

8. Manufacturing warehouse

In this scenario, a manufacturing process (4) consumes material from a production input location (3) in the

manufacturing warehouse (8). When a handling unit of the material (kanban) is consumed, it’s registered as

empty. A replenishment signal is created for the item origin, and a new kanban (1) is created. In this case, the

item origin consists of locations in the material warehouse (7). The material for the kanban is picked and put to a

location (2) in the same warehouse. When the material is picked, it’s ready to be transferred from location 2 to

the production input location (3) in the manufacturing warehouse (8).
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kanban

Configure the withdrawal kanban

Scenario 1: Replenish a production input location by using a fixed
withdrawal kanban

Scenario 2: Automatically complete the transfer activity when kanban
picking work is processed

To enable raw material picking for the withdrawal kanban, configure wave templates, work templates, and

location directives for the Kanban pickingKanban picking work order type. This work order type doesn’t just support the

picking process for the withdrawal kanban. It also supports the picking process for the manufacturing kanban.

However, you can configure a separate picking process for each type of kanban by separating the wave

templates, work templates, and location directives. To separate the wave templates, work templates, and location

directives, set criteria on the activity type (ProcessProcess  or TransferTransfer ) in the queries for those entities.

The transfer activity that is used for the withdrawal kanban is configured as part of an activated activity plan in a

Lean production flow. As part of the configuration of the transfer activity, you specify the “from” and “to”

locations for the transfer. After you configure the transfer activity, you can assign it to a kanban rule of the

WithdrawalWithdrawal  type. The kanban rule sets the policies and configurations for the withdrawal kanban. The quantity

of the kanban defines how many units of the handling unit the kanban carries during the transfer process. The

fixed kanban quantity is used when the Fixed replenishment strategy is selected. This quantity defines how many

kanbans that are required in order to prevent stock or build inventory from running out at the source of

demand. The fixed quantity can be calculated based on actual demand, historical demand, and service levels. The

following two scenarios describe how you can manage material replenishment that uses the withdrawal kanban.

A manufacturing process consumes a purchased raw material from a production input location that is in the

production warehouse. When the raw material is received from the vendor, it’s stored in locations in the material

warehouse. Because the demand for the material is considered stable over a period, it’s set up to supply the

production in a fixed quantity kanban flow. When a kanban is consumed at the production input location, an

empty signal is registered, and a new kanban of the same type is added to the flow.

The empty signal can be configured to occur automatically when a kanban is completed. Alternatively, the empty

signal can be set up as a manual interaction that is given either from the Kanban transfer board or from a menu

on the hand-held device. The Kanban transfer board is the workspace where all activities in the kanban life cycle

are managed.

When the kanban is created, a wave line for the raw material is added to a kanban wave for the material

warehouse. In the picking list section of the Kanban transfer board, the status of the material and related

warehouse processes can be monitored from wave creation to work creation, until the material is on-hand in the

“transfer from” location and is ready to be transferred to the production input locations. The kanban can be

completed either from the Kanban transfer board or from a menu on the hand-held device.

In this scenario, the picking work in the material warehouse is processed as one activity. The transfer activity

between the material warehouse and the production warehouse is processed as a separate activity. This

approach can be useful if, for example, there is a large physical distance between the two warehouses. In this

case, the kanban transfer activity can represent a truck load.

If the distance between the warehouse locations and the production input location is small, it might be more

efficient to include the transfer activity in the picking process. Then, after the material is picked, it can be put

directly to the production input location. To support this process, you configure the transfer activity so that it’s

automatically completed when the pick work of the withdrawal kanban is processed.



NOTENOTE

In the following scenario, the transfer activity of the withdrawal kanban is configured to transfer between two

locations in the same warehouse. The transfer activity of the withdrawal kanban is set up so that it’s completed

automatically.

1. Shared warehouse for raw materials and production

2. Warehouse locations for raw materials

3. Kanban “from” location and put location for warehouse work

4. Withdrawal kanban

5. Production input location

6. Manufacturing process

After a kanban is consumed at the production input location, the kanban is reported as empty, and a new

kanban is added to the flow. When the kanban is created, a wave line is added to a kanban wave. When the

kanban wave is processed, warehouse work for kanban picking is created. The warehouse worker processes the

work for kanban picking and is directed by the work to pick the material for the kanban in a warehouse location.

As this warehouse worker confirms the pick, the kanban is automatically completed, and the warehouse worker

is guided to the put the material to the production input location.
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Create a fixed picking location

Create a replenishment location directive

This procedure shows you how to set up a new replenishment process which uses the minimum/maximum

replenishment strategy. When inventory falls below the minimum level, work will be created to replenish the

location. The procedure also shows how to use fixed picking locations to allow restocking even if inventory falls

below the minimum level, and how to enable the replenishment process to run regularly using a batch job.

These tasks would typically be carried out by a warehouse manager. You can run this procedure in the USMF

demo data company using the example values below, or can run it on your own data. If you're using your own

data, make sure that you have a warehouse that's enabled for Warehouse management processes.

1. Go to Navigation pane > Modules > Warehouse management > Setup > Warehouse > FixedNavigation pane > Modules > Warehouse management > Setup > Warehouse > Fixed

locationslocations . This is an optional task for min-max replenishment, but if you use fixed picking location, this

allows stock to be replenished even if it falls below the minimum level, because the system can determine

which items need to be replenished, even if there aren't any left.

2. Click NewNew .

3. In the Item numberItem number  field, enter or select a value. If you're using USMF, you can select item A0001.

4. In the S iteSite field, enter or select a value. If you're using USMF, you can select site 2.

5. In the WarehouseWarehouse field, enter or select a value. If you're using USMF, you can select warehouse 24.

6. In the LocationLocation field, enter or select a value. If you're using USMF, you can select CP-003.

7. Close the page.

1. Go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives . Location directives are used to

determine where items should be picked from in the replenishment process.

2. In the Work order typeWork order type field, select 'Replenishment'.

3. On the Action PaneAction Pane, click NewNew .

4. In the NameName field, type a value.

5. In the Work typeWork type field, select 'Pick'.

6. In the S iteSite field, enter or select a value. If you're using USMF, you can select site 2.

7. In the WarehouseWarehouse field, enter or select a value. If you're using USMF, you can select warehouse 24.

8. Click SaveSave.

9. In the L inesLines  section, click NewNew .

10. In the list, mark the selected row.

11. In the To quantityTo quantity  field, enter a number. For example, you can set it to 9999.

12. Select the Allow splitAllow split check box. If you select this option, the work creation process will allow work line

quantities to be split across multiple locations.

13. Click SaveSave.

14. In the Location directive ActionsLocation directive Actions  section, click NewNew .

15. In the list, mark the selected row.

16. In the NameName field, type a value.

17. Click SaveSave.

18. On the Action PaneAction Pane, click Edit quer yEdit quer y . You can edit this query to add restrictions where inventory can be

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/tasks/set-up-min-max-replenishment-process.md


Create a replenishment work template

Create a new replenishment template

selected from in the replenishment process. For example, it could be that inventory should only be used from

the Bulk area of the warehouse.

19. Click OKOK.

20. Close the page.

1. Go to Warehouse management > Setup > Work > Work templatesWarehouse management > Setup > Work > Work templates . The work template is use to guide

the system as to how the min/max replenishment work must be created. As a minimum, there must be a

work template line for a pick and a put. The work template will say that it's Invalid until all the necessary

information has been filled in.

2. In the Work order typeWork order type field, select 'Replenishment'.

3. On the Action PaneAction Pane, click NewNew .

4. In the Work templateWork template field, type a value.

5. Click SaveSave.

6. In the Work template detailsWork template details , click NewNew .

7. In the Work typeWork type field, select 'Pick'.

8. In the Work class IDWork class ID field, enter or select a value. This should be a work class related to replenishment. If

you're using USMF, select Replenish.

9. In the Work template detailsWork template details , click NewNew .

10. In the list, mark the selected row.

11. In the Work typeWork type field, select 'Put'.

12. In the Work class IDWork class ID field, enter or select a value.

13. Click SaveSave.

14. Close the page.

1. Go to Warehouse management > Setup > Replenishment > Replenishment templatesWarehouse management > Setup > Replenishment > Replenishment templates . The

replenishment template is used to define the items and quantities, and the location to replenish.

2. On the Action PaneAction Pane, click NewNew .

3. In the Replenish templateReplenish template field, type a value. Give the template a name to indicate that it's for min/max

replenishment.

4. In the Descr iptionDescr iption field, type a value.

5. Select the Allow wave demand to use unreser ved quantitiesAllow wave demand to use unreser ved quantities  check box. If you select this option, it

enables wave demand replenishment to consume quantities that are related to min/max replenishment. For

example, this might be useful if the min/max replenishment work isn't processed immediately, to avoid

unnecessary demand replenishment work from being created.

6. In the Replenishment template detailsReplenishment template details , click NewNew .

7. In the Sequence numberSequence number  field, enter a number.

8. In the Descr iptionDescr iption field, type a value.

9. In the list, mark the selected row.

10. In the Replenishment unitReplenishment unit field, enter or select a value. For example, select pcs. This setting is mandatory. It

allows you to specify a different unit of measurement for replenishment work compared to the unit specified

for the minimum and maximum stock levels in this template.

11. In the Work templateWork template field, enter or select a value. Choose the work template that you created earlier.

12. In the Minimum quantityMinimum quantity  field, enter a number. Select the minimum quantity that should trigger the

replenishment. For example, set this to 50. It is possible to leave this set to zero, if you're replenishing a fixed

location and the Replenish empty fixed locationsReplenish empty fixed locations  option is set to 'Yes'. We also recommend that you



Set the replenishment process to run as a batch job

NOTENOTE

select the Replenish only fixed locationsReplenish only fixed locations  option for performance reasons.

13. In the Maximum quantityMaximum quantity  field, enter a number. For example, set this to 100.

14. In the UnitUnit field, enter or select a value. Assign the unit for the minimum and maximum quantities. For

example, set this to pcs.

15. Select the Replenish empty fixed locationsReplenish empty fixed locations  check box. Select this check box to replenish fixed locations

when they are empty. Otherwise, only the locations where there is a quantity on hand will be replenished.

16. Select the Replenish only fixed locationsReplenish only fixed locations  check box.

17. Click Select productsSelect products . This is the place to define which products should be replenished. If the Fixed picking

locations option is selected, you also need to define the locations in this query. Variant-specific queries are

available as well product-specific queries.

18. Select the ItemsItems row.

19. In the Criter iaCriter ia field, type a value. Select the items that should be replenished at the fixed locations. For

example, type A* to select all item numbers beginning with A.

20. Click AddAdd. Add the Location entity (unless it already exists) to be able to restrict the replenishment work to

the fixed picking locations within a specific area of the warehouse.

21. In the list, mark the selected row.

22. Set the TableTable field to 'Locations'.

23. In the FieldField field, select 'Location profile ID'.

24. In the Criter iaCriter ia field, enter or select a value.

25. Click OKOK.

26. Close the page.

1. Go to Warehouse management > Replenishment > ReplenishmentsWarehouse management > Replenishment > Replenishments . The Replenishments page allows

you to set up replenishment to run as a batch job, or to require that it's started manually.

2. Click FilterFilter .

3. In the list, mark the selected row.

4. In the Criter iaCriter ia field, enter or select a value.

5. Click OKOK.

6. Expand the Run in the backgroundRun in the background section.

7. Set the Batch processingBatch processing option to 'Yes'.

8. Click RecurrenceRecurrence.

9. Select the No end dateNo end date option.

10. Set the Recurrance patternRecurrance pattern. For example, select Days.

11. Click OKOK.

12. Click OKOK.
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Turn on the Zone threshold replenishment feature

Set up zone-based replenishment

Set up directive codesSet up directive codes

View and edit directive codesView and edit directive codes

Prepare demo data directive codesPrepare demo data directive codes

Zone-based replenishment uses a minimum/maximum (min/max) replenishment strategy, but it evaluates

whole warehouse zones instead of just individual locations. Therefore, warehouse managers can more quickly

learn when additional inventory is required in a picking zone.

The setup for this feature resembles the setup for location-based replenishment. However, when you set up a

template for min/max replenishment, you can also specify whether the threshold should be evaluated per

location or per zone. If you set up evaluation that is based on zones, you must add specific zones to the zone

selection query.

Like location-based min/max replenishment, zone-based min/max replenishment is based the setup of a

minimum inventory threshold that triggers the creation of replenishment work for selected items. This

replenishment work will increase inventory up to the specified maximum threshold for the zone.

Zone replenishment processes for product variants aren't supported in the current release.

Unlike location-based min/max replenishment, zone-based min/max replenishment doesn't require fixed

locations to evaluate whether locations should store a specific item. Therefore, zone-based replenishment lets

you use min/max replenishment even if you don't have fixed locations for each item or item variant in the

warehouse. When a quantity in the zone falls below the specified minimum threshold, replenishment work is

created. Location directives will determine which specific location the inventory should be put into.

Before you can use the Zone threshold replenishment feature, it must be turned on in your system. Admins can

use the feature management settings to check the status of the feature and turn it on if it's required. In the

Feature managementFeature management workspace, the feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Zone threshold replenishment

To set up zone-based replenishment, you must configure several parts of the system. This section introduces the

various settings and provides demo data values that you can enter if you want to work through the scenario at

the end of this topic.

Directive codes let you be more specific when you define the location template that is used in a work template.

Each code establishes a common value that you can refer to when you configure each type of template.

To view or edit your directive codes, go to Warehouse management > Setup > Directive codesWarehouse management > Setup > Directive codes .

This example shows how to prepare a directive code. If you're planning to work through the scenario at the end

of this topic, use the demo data values that are provided here. Otherwise, use your own values.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/zone-threshold-replenishment.md


Set up replenishment templatesSet up replenishment templates

View and edit replenishment templatesView and edit replenishment templates

Prepare a demo data replenishment templatePrepare a demo data replenishment template

1. Select the USMFUSMF legal entity to work with the demo data.

2. Go to Warehouse management > Setup > Directive codesWarehouse management > Setup > Directive codes .

3. On the Action Pane, select NewNew  to add a row to the grid.

4. In the new row, set the following values:

Directive code:Directive code: Zone replen

Directive descr iption:Directive descr iption: Zone replenishment

5. Select SaveSave to save the new code.

Min/max replenishment templates are the primary mechanism for maintaining optimal levels in picking

locations. In these templates, you must set up the rules that will be used to replenish inventory in the

warehouse. The replenishment that the templates can be used for includes zone-based replenishment.

A replenishment template is a set of rules that control when and how a location is replenished. You select a

template to control when and how replenishment is done. To view or edit your replenishment templates, go to

Warehouse management > Setup > Replenishment > Replenishment templatesWarehouse management > Setup > Replenishment > Replenishment templates .

This example shows how to prepare a replenishment template. If you're planning to work through the scenario

at the end of this topic, use the demo data values that are provided here. Otherwise, use your own values.

1. Select the USMFUSMF legal entity to work with the demo data.

2. Go to Warehouse management > Setup > Replenishment > Replenishment templatesWarehouse management > Setup > Replenishment > Replenishment templates .

3. Select EditEdit to put the page into edit mode.

4. On the Action Pane, select NewNew  to add a row to the Over viewOver view  grid.

5. In the new row, set the following values. Accept the default values for all other fields.

Replenish template:Replenish template: Zone min/max replen

Descr iption:Descr iption: Zone min/max replenishment

Replenishment type:Replenishment type: Minimum or maximum

6. Select SaveSave.

7. While the new row is still selected in the Over viewOver view  grid, select NewNew  above the ReplenishmentReplenishment

Template DetailsTemplate Details  grid to add a row that is associated with the Zone Min/Max replen replenishment

template that you just created.

8. In the new row, set the following values:

Sequence number :Sequence number : Enter 1.

Descr iption:Descr iption: Enter Pick zone replenishment.

Replenishment unit:Replenishment unit: Select ea.

Request type:Request type: Leave this field blank.

Directive code:Directive code: This field links the replenishment template with a location directive. Select the demo

data directive code that you created earlier (Zone replen).

Work template:Work template: Leave this field blank.

Minimum quantity:Minimum quantity: This field sets the quantity that replenishment will be triggered at. Enter 50.

Maximum quantity:Maximum quantity: This field sets the maximum quantity of an item that can be present in a zone.

Generated replenishment work will increase inventory to this quantity. Enter 150.



Set up location directivesSet up location directives

View and edit location directivesView and edit location directives

Prepare demo data location directivesPrepare demo data location directives

C r e a t e  a  r e p l e n i sh m e n t  p i c k  d i r e c t i v eC r e a t e  a  r e p l e n i sh m e n t  p i c k  d i r e c t i v e

Unit:Unit: This field sets the unit for the minimum and maximum values. Select ea.

Demand increment:Demand increment: Select Round up.

Replenish empty fixed locations:Replenish empty fixed locations: Select this check box.

Replenish only fixed locations:Replenish only fixed locations: Clear this check box.

Product quer y mode:Product quer y mode: Select Product query.

Replenishment threshold scope:Replenishment threshold scope: This field defines whether the template should evaluate by zone

or by specific location. Select Zone.

Warehouse:Warehouse: Select 61.

9. Select Select productsSelect products  above the Replenishment Template DetailsReplenishment Template Details  grid.

10. In the Product quer yProduct quer y  dialog box, on the RangeRange tab, select AddAdd to add a row to the grid.

11. In the new row, set the following values:

Table:Table: Items

Derived table:Derived table: Items

Field:Field: Item number

Criter ia:Cr iter ia: A0001

12. Select OKOK to save your query and close the dialog box.

13. Select Select zones to replenishSelect zones to replenish above the Replenishment Template DetailsReplenishment Template Details  grid.

14. In the Zone quer yZone quer y  dialog box, on the RangeRange tab, add a row to the grid.

15. In the new row, set the following values:

Table:Table: Warehouse zone

Derived table:Derived table: Warehouse zone

Field:Field: Zone ID

Criter ia:Cr iter ia: FLOOR

16. Select OKOK to save your query and close the dialog box.

Unlike location-based min/max replenishment, zone-based min/max replenishment requires that you set up

both pick location directives and put location directives, because the system evaluates the whole zone instead of

just the pick location for outbound work.

To view or edit your location directives, go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives .

For examples that show how to use the settings to create the required pick location directives and put location

directives, see the next section.

To prepare demo data so that it can be used in the scenario at the end of this topic, you must create two location

directives: one for pick and one for put.

1. Select the USMFUSMF legal entity to work with the demo data.

2. Go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives .

3. In the left pane, set the Work order typeWork order type field to Replenishment.

4. On the Action Pane, select NewNew  to create a new directive.

5. Set the following values:



C r e a t e  a  r e p l e n i sh m e n t  p u t  d i r e c t i v eC r e a t e  a  r e p l e n i sh m e n t  p u t  d i r e c t i v e

Sequence number :Sequence number : Accept the default value.

Name:Name: Enter Zone pick.

Work type:Work type: Select Pick.

S ite:S ite: Select 6.

Warehouse:Warehouse: Select 61.

Directive code:Directive code: Leave this field blank.

Multi SKU:Multi SKU: Set this option to No.

6. Select SaveSave to create a directive that has the settings that you've configured so far.

7. On the L inesLines  FastTab, select NewNew  to add a line to the grid.

8. On the new line, set the following values:

Sequence number :Sequence number : Enter 1.

From quantity:From quantity: Enter 0.

To quantity:To quantity: Enter 10000000.

Unit:Unit: Leave this field blank.

Locate quantity:Locate quantity: Select None.

Restr ict by unit:Restr ict by unit: Clear this check box.

Round up to unit:Round up to unit: Clear this check box.

Locate packing quantity:Locate packing quantity: Clear this check box.

Allow split:Allow split: Select this check box.

9. Select SaveSave to save the new line.

10. While your new line is still selected in the L inesLines  grid, select NewNew  on the Location Directive ActionsLocation Directive Actions

FastTab to add a row to the grid.

11. In the new row, set the following values:

Sequence number :Sequence number : Enter 1.

Name:Name: Enter Pick from bulk.

Fixed location usage:Fixed location usage: Select Fixed and non-fixed locations.

Allow negative inventor y:Allow negative inventor y: Clear this check box.

Batch enabled:Batch enabled: Clear this check box.

Strategy:Strategy: Select None.

12. Select SaveSave to save the new action.

13. While your new action still selected, select Edit quer yEdit quer y  above the Location Directive ActionsLocation Directive Actions  grid.

14. A query dialog box appears, where you can select the locations to replenish from. On the RangeRange tab,

select AddAdd to add a row to the grid.

15. In the new row, set the following values:

Table:Table: Locations

Derived table:Derived table: Locations

Field:Field: Zone ID

Criter ia:Cr iter ia: BULK

16. Select OKOK to save your query and close the dialog box.

17. Select SaveSave to save your location directive.

1. On the Location directivesLocation directives  page, in the left pane, make sure that the Work order typeWork order type field is still set



to Replenishment.

2. On the Action Pane, select NewNew  to create another new directive.

3. Set the following values:

Sequence number :Sequence number : Accept the default value.

Name:Name: Enter Zone put.

Work order type:Work order type: Select Put.

S ite:S ite: Select 6.

Warehouse:Warehouse: Select 61.

Directive code:Directive code: Select Zone replen to link this location directive with the replenishment template that

you created earlier by using the code that you created earlier.

Multi SKU:Multi SKU: Set this option to No.

4. Select SaveSave to create a directive that has the settings that you've configured so far.

5. On the L inesLines  FastTab, select NewNew  to add a line to the grid.

6. On the new line, set the following values:

Sequence number :Sequence number : Enter 1.

From quantity:From quantity: Enter 0.

To quantity:To quantity: Enter 10000000.

Unit:Unit: Leave this field blank.

Locate quantity:Locate quantity: Select None.

Restr ict by unit:Restr ict by unit: Clear this check box.

Round up to unit:Round up to unit: Clear this check box.

Locate packing quantity:Locate packing quantity: Clear this check box.

Allow split:Allow split: Select this check box.

7. Select SaveSave to save the new line.

8. While your new line is still selected in the L inesLines  grid, select NewNew  on the Location Directive ActionsLocation Directive Actions

FastTab to add a row to the grid.

9. In the new row, set the following values:

Sequence number :Sequence number : Enter 1.

Name:Name: Enter Zone put.

Fixed location usage:Fixed location usage: Select Fixed and non-fixed locations.

Allow negative inventor y:Allow negative inventor y: Clear this check box.

Batch enabled:Batch enabled: Clear this check box.

Strategy:Strategy: Select Consolidate.

10. Select SaveSave to save the new action.

11. While your new action is still selected, select Edit quer yEdit quer y  above the Location Directive ActionsLocation Directive Actions  grid.

12. A query dialog box appears, where you can select the zone to replenish to. This zone should be the same

zone that is specified in the replenishment template. On the RangeRange tab, select AddAdd to add a row to the

grid.

13. In the new row, set the following values:

Table:Table: Locations

Derived table:Derived table: Locations

Field:Field: Zone ID



Scenario

Prepare the sample data that is required for the sample scenarioPrepare the sample data that is required for the sample scenario

Use the USMF legal entityUse the USMF legal entity

Prepare additional sample dataPrepare additional sample data

Check your on-hand inventoryCheck your on-hand inventory

Criter ia:Cr iter ia: FLOOR

14. Select OKOK to save your query and close the dialog box.

15. Select SaveSave to save your location directive.

This section provides a sample scenario that shows how to work with the feature.

Before you start to work through the scenario, you must activate sample data and set up the feature as

described in this section and in the previous sections of this topic.

To work through the scenario by using the sample records and values that are specified here, you must be on a

system where the standard demo data is installed. Additionally, you must select the USMFUSMF legal entity before

you begin.

After you've selected the USMFUSMF legal entity, add the additional sample data that is required, as described in the

Set up zone-based replenishment section earlier in this topic.

Follow these steps to make sure that your system includes enough inventory to support the sample scenario.

1. Make sure that there is on-hand inventory for item A0001 at two different locations in the pick zone

(FLOOR) that is specified in the replenishment template. However, the total inventory should be less than

the required minimum quantity (50) that is specified on the replenishment template. In this way, you can

simulate how the calculation occurs for the whole zone instead of just for a single location. Use any ofUse any of

the warehouse processes to adjust inventor y as required.the warehouse processes to adjust inventor y as required.

2. Make sure that there is enough inventory for item A0001 at a bulk location that is specified in the zone

pick location directive where the replenishment work should pick the items from zone ID BULK. The total

inventory must be more than the required maximum quantity (150) that is specified in the replenishment

template.

3. Optional but recommended: Follow these steps to create an inventory adjustment journal:

a. Go to Inventor y management > Journal entr ies > Items > Inventor y adjustmentInventor y management > Journal entr ies > Items > Inventor y adjustment.

b. Select NewNew .

c. In the Create inventor y journalCreate inventor y journal  dialog box, in the WarehouseWarehouse field, select 61.

d. Select OKOK.

e. On the Journal linesJournal lines  FastTab, use the NewNew  button to add three lines to the grid, and set the

following values. After you've finished setting up each line, select SaveSave.

L ine 1:L ine 1:

Item number :Item number : A0001

Site:S ite: 6

Warehouse:Warehouse: 61

Location:Location: 02A01R1S1B

License plate:L icense plate: Select an existing license plate in the list, or create a new license plate.

Quantity:Quantity: 1000

Line 2:L ine 2:



Sample scenario: Run zone-based min/max replenishmentSample scenario: Run zone-based min/max replenishment

Notes and tips

Item number :Item number : A0001

Site:S ite: 6

Warehouse:Warehouse: 61

Location:Location: 07A01R2S1B

License plate:L icense plate: Select an existing license plate in the list, or create a new license plate.

Quantity:Quantity: 15

Line 3:L ine 3:

Item number :Item number : A0001

Site:S ite: 6

Warehouse:Warehouse: 61

Location:Location: 07A01R1S1B

License plate:L icense plate: Select an existing license plate in the list, or create a new license plate.

Quantity:Quantity: 10

f. On the Action Pane, select ValidateValidate. Address any errors that are found before you move on to the

next step.

g. On the Action Pane, select PostPost to post the inventory to the warehouse.

After all the prerequisite sample data is in place, you can trigger replenishment by following these steps.

1. Go to Warehouse management > Replenishment > ReplenishmentsWarehouse management > Replenishment > Replenishments .

2. In the ReplenishmentReplenishment dialog box, on the Records to includeRecords to include FastTab, select FilterFilter .

3. In the Inquir yInquir y  dialog box, on the RangeRange tab, edit the default table row in the following way:

Table:Table: Select Replenishment templates.

Derived table:Derived table: Select Replenishment templates.

Field:Field: Select Replenishment template.

Cr iter ia:Cr iter ia: Select Zone min/max replen. This replenishment template is the replenishment template that

you created while you were preparing the demo data for this scenario.

4. Select OKOK to save the query and go back to the ReplenishmentReplenishment dialog box.

5. Select OKOK to run the replenishment template.

Replenishment work is now created to pick inventory from the BULK zone and replenish it to the FLOOR zone.

Here are a few notes and tips for working with the feature:

To set up replenishment work that goes to the desired zone, you can link the replenishment template

lines and location directives in either of the following ways:

Edit the location directive header query, and filter the selected replenishment template lines.

Use a directive code on the replenishment template line, and match it to the put location directive.

If you're using dynamic locations, replenishment work will be created either for the first available location

or for a location that already contains inventory, if the location directive action is set up to use the

ConsolidateConsolidate strategy.

If you're using fixed locations instead of zones, you should use standard min/max replenishment.
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IMPORTANTIMPORTANT

Turn on the Replenish to max based on stocking limits feature

Set up replenishment strategies

The templates that are defined on the Replenishment templatesReplenishment templates  page include wave demand replenishment

template lines that let you select how replenishment is done. Each line now includes a ReplenishmentReplenishment

strategystrategy  field.

The Wave demand quantity strategy is the default strategy. It's the replenishment strategy that was used before

the introduction of the Replenishment strategyReplenishment strategy  field. It uses the replenishment location directives to find

locations that can be replenished. It then replenishes those locations until the demand is covered.

The Maximum location capacity strategy introduces some new functionality. Like the Wave demand quantity

strategy, this strategy uses the replenishment location directives to find locations that can be replenished, and

then it replenishes those locations until the demand is covered. It differs from the Wave demand quantity

strategy in that all the replenished locations are replenished to their maximum capacity, as defined by the

location stocking limits. The Maximum location capacity strategy tries to create work to bring in the requested

quantity, plus some extra quantity, to fill the locations that are being replenished. However, in some cases, that

attempt might fail. For example, the bulk locations might not have enough inventory to cover the extra quantity.

In these cases, the system detects the failure and tries to recover.

Peak season is one example of a situation where the Maximum location capacity strategy is preferable to the

Wave demand quantity strategy. During peak season, some items might be selling at high volume. Therefore,

you might want to proactively replenish the relevant picking locations as much as possible, to reduce the

number of work IDs that are created for replenishment.

To take full advantage of the Maximum location capacity strategy, you must redefine the stocking limits for the relevant

locations. Otherwise, this strategy works just like the Wave demand quantity strategy.

Before you can use this feature, it must be turned on in your system. Administrators can use the Feature

management workspace to check the status of this feature and turn it on if it's required. There, the feature is

listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Replenish to max based on stocking limits

To access the templates, go to Warehouse management > Setup > Replenishment > ReplenishmentWarehouse management > Setup > Replenishment > Replenishment

templatestemplates . In the Over viewOver view  section, select or create a wave demand replenishment template where the

Replenishment typeReplenishment type field is set to Wave demand. Then set up the replenishment template lines in the

Replenishment template detailsReplenishment template details  section. For each line, in the Replenishment strategyReplenishment strategy  field, select the

replenishment strategy that you want to use.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/replenishment-strategies.md


NOTENOTE

Example scenarios
Example 1Example 1

If the Replenishment strategyReplenishment strategy  column doesn't appear in the grid in the Replenishment template detailsReplenishment template details

section, make sure that the feature has been turned on, and that the selected replenishment template has a

replenishment type of Wave demand.

The Wave demand quantity strategy is the default strategy. Therefore, you just have to update the replenishment

template lines where you want to use the Maximum location capacity strategy instead.

For this example, there is only one replenishment template that has only one replenishment template line.

You create a sales order for 130 pieces (pcs) of item A0001. Before you release the order to the warehouse, the

warehouse is set up in the following way:

There is only one bulk location, and it has 500 pcs of available on-hand inventory.

There are three pick locations, each of which has a stocking limit of 100 pcs. (Remember that stocking limits

are required for the Maximum location capacity strategy.)

The replenishment put locations are the same as the sales pick locations.

The replenishment unit is a box (1 box = 20 pcs).

At the time of the order, the following inventory is on hand at the sales pick locations:

Pick-001:Pick-001: 20 pcs (1 box)

Pick-002:Pick-002: 0 pcs

Pick-003:Pick-003: 0 pcs

Initially, the replenishment strategy is set to Wave demand quantity.

After you release the sales order to the warehouse, and wave processing runs for the wave, you get the

following replenishment work:

Replenishment work 1:Replenishment work 1: Pick 4 boxes from the bulk location, and put them in location pick-001.

Replenishment work 2:Replenishment work 2: Pick 2 boxes from the bulk location, and put them in location pick-002.

You get two replenishment work IDs because you must replenish two locations, and multi-puts aren't supported.

If you set the replenishment strategy to Maximum location capacity instead, you get the following

replenishment work:

Replenishment work 1:Replenishment work 1: Pick 4 boxes from the bulk location, and put them in location pick-001.



Example 2Example 2

Replenishment work 2:Replenishment work 2: Pick 5 boxes from the bulk location, and put them in location pick-002.

This example shows what happens when the bulk location doesn't have enough inventory to cover the extra

quantity. It uses the same scenario as example 1, but the bulk location has 160 pcs (8 boxes).

The Wave demand quantity strategy creates the same work that it did in example 1.

However, because the Maximum location capacity strategy tries to create the work IDs as it did in example 1, it

might fail. At that point, the system tries to recover.

Depending on the setting of the Allow splitAllow split option on the location directives for replenishment picking, two

outcomes are possible:

If the Allow splitAllow split option is set to Yes, the following replenishment work is created:

Replenishment work 1:Replenishment work 1: Pick 4 boxes from the bulk location, and put them in location pick-001.

Replenishment work 2:Replenishment work 2: Pick 4 boxes from the bulk location, and put them in location pick-002.

file:///T:/eiye/ac1a/dynamics365/supply-chain/warehousing/media/replentemp_example_1_large.png


If the Allow splitAllow split option is set to No, the following replenishment work is created:

Replenishment work 1:Replenishment work 1: Pick 4 boxes from the bulk location, and put them in location pick-001.

Replenishment work 2:Replenishment work 2: Pick 2 boxes from the bulk location, and put them in location pick-002.

The outcomes differ because of the information that is available when you create the work. When the AllowAllow

splitsplit is set to Yes on the location directives for replenishment picking, you know that you managed to find 160

pcs. Therefore, you can create work for that quantity. However, when the Allow splitAllow split option is set to No, you

don't know about the existence of the 160 pcs. Because the extra quantity that you decided to replenish was 3

boxes, you drop that extra quantity and try the original quantity again.

Therefore, to get the maximum quantity to the replenished locations, you should set the Allow splitAllow split option to

Yes on the location directives for replenishment picking.

file:///T:/eiye/ac1a/dynamics365/supply-chain/warehousing/media/replentemp_example_2_large.png
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Turn on the Replenishment over location capacity feature

Set up the feature for the example scenario

Enable sample dataEnable sample data

Location profileLocation profile

Some high-volume or space-constrained warehouses must ship more quantity of an item in a day than will fit in

the picking location. The Replenishment over location capacity feature enables all replenishment work that will

be required for the day to be created and manages availability of that replenishment work to ensure that the

picking location neither runs out of inventory nor goes above capacity.

The feature enables more replenishment work to be created than will fit in a location, and it blocks

replenishment work from being completed when the location is full. As inventory in the picking location drops

below a configurable threshold, more replenishment work is made available.

To make this feature available, turn on the following features in feature management (in this order):

1. Organization-wide work blocking

2. Replenishment over location capacity

This section provides guidelines and an example that shows how to set up this feature and prepare sample data

for the example scenario that is provided later in this topic.

To work through the example scenario by using the sample records and values that are specified here, you must

be on a system where the standard demo data is installed. Additionally, you must select the USMFUSMF legal entity

before you begin.

Enable the replenish over capacity functionality on the location profile.

1. Go to Warehouse management > Setup > Warehouse > Locations profilesWarehouse management > Setup > Warehouse > Locations profiles .

2. In the left pane, select PICK-06PICK-06 .

3. On the Action Pane, select EditEdit.

4. On the ReplenishmentReplenishment FastTab, set the following values:

Exceed Location Capacity:Exceed Location Capacity: Yes

When enabled, the maximum capacity of the location will be allowed to be exceeded by

replenishment work. This also enables other fields on the ReplenishmentReplenishment FastTab.

Work availability threshold type:Work availability threshold type: Quantity

This field defines the method that is used to determine when more work should be released. You

can release by either quantity or a percentage:

Percent – Select this option to use percentage capacity that is based on stocking limits or

volumetrics. Selecting this option enables the Overflow percentageOverflow percentage field, and disables the

two quantity related fields, Overflow quantityOverflow quantity  and Overflow unitOverflow unit.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/replenishment-over-location-capacity.md


IMPORTANTIMPORTANT

Wave step codeWave step code

NOTENOTE

You can use this option if the picking locations use volumetrics.

If this option is selected, set the Overflow percentageOverflow percentage field to the percentage at which

more replenishment work will be made available.

Quantity – Select this option to use a specific quantity value. Selecting this option disables

the Overflow percentageOverflow percentage field and enables Overflow quantityOverflow quantity  and Overflow unitOverflow unit

fields.

Use this option when you aren't using volumetrics for the locations that are being

replenished, or when you have consistent quantities at which you want more inventory to

be brought to the location.

If this option is selected, set the Overflow quantityOverflow quantity  and Overflow unitOverflow unit fields to the

quantity and unit at which more replenishment work will be made available.

Overflow quantity:Overflow quantity: 0.65

This field defines the quantity at which the location overflows.

Work will be available whenever the sum of the on-hand quantity in the location and the work

quantity is below this value. Any replenishment work above this value will be blocked and must be

manually unblocked.

Location stocking limits are considered when the work quantity is calculated.

Overflow unit:Overflow unit: PL

This field defines the unit that is associated with the overflow quantity.

In this case, more replenishment work will be made available when the location gets down to 0.65

pallet (PL).

Overflow percentageOverflow percentage

This field defines the percentage at which the location overflows.

Work will be available whenever the sum of the on-hand quantity in the location and the work

quantity is below this percentage. Any replenishment work quantity percentage above this value

will be blocked and must be manually unblocked.

Location stocking limits are considered when the work quantity percentage is calculated. If no

location stocking limits are defined, the work quantity percentage is calculated by volume if

volume constraints are defined for the location profile.

If you're using the demo data for the USMFUSMF legal entity and previously turned on the Location license plate positioning

feature, you must turn off the Enable license plate positioningEnable license plate positioning setting for the BULK-06BULK-06  location profile to complete

the mobile steps in the example scenario.

To set up a wave step code as described here, you might first have to use feature management to turn on the feature that

is named Organization wide wave step code.

1. Go to Warehouse Management > Setup > Waves > Wave step codesWarehouse Management > Setup > Waves > Wave step codes .



 

Replenishment templateReplenishment template

Wave templateWave template

Example scenario

Create replenishment workCreate replenishment work
Create sales order 1Create sales order 1

2. Select NewNew , and set the following values:

Wave step code:Wave step code: Replen

Wave step descr iption:Wave step descr iption: Replenishment

Wave step type:Wave step type: Replenishment

3. Select SaveSave.

Replenishment templates are a set of rules that control when and how a location is replenished.

1. Go to Warehouse management > Setup > Replenishment > Replenishment templatesWarehouse management > Setup > Replenishment > Replenishment templates .

2. On the Action Pane, select EditEdit.

3. In the Over viewOver view  section, select the line where the Replenish templateReplenish template field is set to Demand replenish.

4. Set the following values:

Wave step code:Wave step code: Replen

Allow wave demand to use unreser ved quantities:Allow wave demand to use unreser ved quantities: Yes

5. Select SaveSave.

1. Go to Warehouse management > Setup > Waves > Wave templatesWarehouse management > Setup > Waves > Wave templates .

2. In the left pane, set the Wave template typeWave template type field to Shipping.

3. Select template 61 Shipping61 Shipping in the list.

4. On the Action Pane, select EditEdit.

5. On the GeneralGeneral  FastTab, set the Automate replenishment work releaseAutomate replenishment work release option to Yes.

Set this option to Yes to create demand-based replenishment work and release it automatically. You must

add the replenishment wave method to the wave template and create a replenishment template of the

Wave demandWave demand type. Set up a replenishment template on the Replenishment templatesReplenishment templates  page. To set

up a replenishment template, you must add the replenish method to the wave template.

6. On the MethodsMethods  FastTab, in the Selected methodsSelected methods  column, find the following line:

Method name:Method name: replenish

Name:Name: Replenishment

7. Set the Wave step codeWave step code field for this line to Replen.

8. Select SaveSave.

After you've made all the previously described sample data available and set it up, you can work through this

scenario to try out the Replenishment over location capacity feature. The values that are shown in this scenario

assume that you're working with the standard demo data, that you selected the USMFUSMF legal entity, and that you

prepared the sample records that are described earlier in this topic. This scenario also serves as an example that

shows how the feature can be used in a production setting.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. On the Action Pane, select NewNew  to open a dialog box for creating a new sales order.



Create sales order 2Create sales order 2

Create sales order 3Create sales order 3

3. In the dialog box, set the following values:

Customer account:Customer account: US-007

Warehouse:Warehouse: 61

4. Select OKOK to create the sales order and close the dialog box.

5. The new sales order is opened. It includes a new, empty line on the Sales order linesSales order lines  FastTab. On this

line, set the following values:

Item number :Item number : T0100

Quantity:Quantity: 40

6. On the Sales order linesSales order lines  FastTab, select Inventor y > Reser vationInventor y > Reser vation.

7. On the Reser vationReser vation page, select Reser ve lotReser ve lot.

8. Close the page.

9. On the Action Pane, on the WarehouseWarehouse tab, select Release to warehouseRelease to warehouse.

You receive informational messages that show the wave and shipment IDs that were created. A

replenishment wave is also created.

You also receive a warning message that states, "Work ID XXXX cannot be unblocked because it has

unfinished replenishment work."

1. On the All sales ordersAll sales orders , page, on the Action Pane, select NewNew  to open a dialog box for creating a new

sales order.

2. In the dialog box, set the following value:

Customer account:Customer account: US-001

Warehouse:Warehouse: 61

3. Select OKOK to create the sales order and close the dialog box.

4. The new sales order is opened. It includes a new, empty line on the Sales order linesSales order lines  FastTab. On this

line, set the following values:

Item number :Item number : T0100

Quantity:Quantity: 60

5. On the Sales order linesSales order lines  FastTab, select Inventor y > Reser vationInventor y > Reser vation.

6. On the Reser vationReser vation page, select Reser ve lotReser ve lot.

7. Close the page.

8. On the Action Pane, on the WarehouseWarehouse tab, select Release to warehouseRelease to warehouse.

You receive informational messages that show the wave and shipment IDs that were created. A

replenishment wave is also created.

You also receive a warning message that states, "Work ID XXXX cannot be unblocked because it has

unfinished replenishment work."

1. On the All sales ordersAll sales orders  page, on the Action Pane, select NewNew  to open a dialog box for creating a new

sales order.

2. In the dialog box, set the following values:



View work detailsView work details

On-hand inventory license plate IDOn-hand inventory license plate ID

Customer account:Customer account: US-004

Warehouse:Warehouse: 61

3. Select OKOK to create the sales order and close the dialog box.

4. The new sales order is opened. It includes a new, empty line on the Sales order linesSales order lines  FastTab. On this

line, set the following values:

Item number :Item number : T0100

Quantity:Quantity: 30

5. On the Sales order linesSales order lines  FastTab, select Inventor y > Reser vationInventor y > Reser vation.

6. On the Reser vationReser vation page, select Reser ve lotReser ve lot.

7. Close the page.

8. On the Action Pane, on the WarehouseWarehouse tab, select Release to warehouseRelease to warehouse.

You receive informational messages that show the wave and shipment IDs that were created. A

replenishment wave is also created.

You also receive a warning message that states, "Work ID XXXX cannot be unblocked because it has

unfinished replenishment work."

1. Go to Warehouse management > Work > Work detailsWarehouse management > Work > Work details .

2. In the Over viewOver view  section, filter the WarehouseWarehouse column for warehouse 61.

3. You should see that seven work IDs were created for the three demand sales orders.

Three of the seven work IDs have a Work order typeWork order type value of Replenishment, and four have a

Work order typeWork order type value of Sales orders.

All three work IDs that have a Work order typeWork order type value of Replenishment have the same Pick and

Put locations in the L inesLines  section:

Pick :Pick : 02A01R5S1B

Put:Put: 06A01R2S1B

Two work IDs were created for sales order 1.

4. Make a note of the work IDs for the sales orders.

Depending on your on-hand quantities, the work quantities that are created might vary slightly. However,

overall, the work headers that are created should match this scenario example.

Later in this scenario, you will use the warehouse app (or an emulator), where you must identify the license plate

to complete the picking and replenishment scenarios.

To find the license plate IDs that you will need later, follow these steps.

1. Go to Inventor y management > Inquir ies and repor ts > On-hand listInventor y management > Inquir ies and repor ts > On-hand list.

2. Select the Show filtersShow filters  button to open the filter pane.

3. Enter the following filtering criteria to get the license plates for the scenario. Use the begins with filter.

Item number :Item number : T0100

Warehouse:Warehouse: 61

4. Select ApplyApply .



Process stepsProcess steps

ReplenishmentReplenishment

Sales order pickSales order pick

5. On the Action Pane, select DimensionsDimensions .

6. In the Dimensions displayDimensions display  dialog box, in the Storage DimensionsStorage Dimensions  section, select all the values.

7. In the TransactionsTransactions  section, select Item numberItem number  and Quantity <> 0Quantity <> 0 .

8. When you've finished, select OKOK to close the dialog box.

9. The On-handOn-hand grid shows the license plate numbers for item T0100 in each location. Make a note of the

license plate that is in each location, because you will need this information later.

10. Close the page.

You will perform the warehouse location replenishment for the first two work IDs. Work on the third

replenishment work will be blocked until the inventory level in the picking location falls below the threshold.

1. Sign in to the warehouse app as a user in warehouse 61. (Enter 61 as the user ID and 1 as the password.)

2. Go to Inventor y > ReplenishmentInventor y > Replenishment.

You're prompted to complete the first replenishment work. The item number, quantity, and location to

pick from are shown.

3. In the LPLP field, enter the license plate number for the item in the location that is shown.

4. Select the OKOK button (check mark symbol).

The system generates a target license plate number for the new license plate for the picked item.

5. Select OKOK to confirm the value.

Put work is shown that instructs the user to put the target license plate into the replenishment location.

The Put location should be 06A01R2S1B06A01R2S1B.

6. Confirm the put details, and select OKOK.

You receive a "Work Completed" message, and the details of the next replenishment pick task are shown:

the item number, quantity, and location to pick from. The picking location will be the same as the first

replenishment location. Therefore, the license plate will have the same license plate ID that was used for

the first replenishment work task.

7. Repeat the preceding steps to complete the replenishment work for the second work task. The quantity

and target license plate will differ from the quantity and target license plate for the first work task.

After the second replenishment work is completed, you receive a "Work Completed" message. The mobile

device also informs you that there is no work available, even though some replenishment work remains. This

behavior occurs because the replenishment work has an availability status of Held and is therefore marked as

BlockedBlocked.

The Held status was triggered because the location profile for the picking location that the work is being

assigned to has an Overflow quantityOverflow quantity  value of 0.65 PL. The two previous replenishment work tasks filled the

location almost to its overflow limit for item T0100. (The unit conversion for the item is 1 PL = 100 ea.)

Therefore, the remaining replenishment work would cause the location to exceed its overflow limit.

Until enough inventory is picked from the location to bring it below the work release threshold on the mobile

device menu item, this replenishment work will remain blocked.

Before the remaining replenishment work task can be completed, the picking location must be depleted of



inventory to a level where the remaining replenishment work can be unblocked. In other words, the sum of the

quantity of on-hand inventory in the location and the replenishment quantity can't exceed the OverflowOverflow

quantityquantity  value. When this sum is less than the overflow quantity, the remaining replenishment work will be

unblocked.

1. Sign in to the warehouse app as a user in warehouse 61. (Enter 61 as the user ID and 1 as the password.)

2. Go to Outbound > Sales PickingOutbound > Sales Picking.

3. Enter the first work ID for sales order 1.

Refer to the work IDs for sales orders that you made a note of earlier, on the Work detailsWork details  page. The

work ID that you enter here will generate pick work for a quantity of 10 ea from two separate locations.

4. Select OKOK.

The Sales orders: PickSales orders: Pick  task page shows the item number, quantity, and location to pick from for the first

location.

5. In the LPLP field, enter the license plate number for the item in the location that is shown.

6. Select the OKOK button (check mark symbol).

The Sales orders: PickSales orders: Pick  task page shows the item number, quantity, and location to pick from for the

next location.

7. In the LPLP field, enter the license plate number for the item in the location that is shown.

8. Select the OKOK button (check mark symbol).

The Sales orders: PutSales orders: Put page instructs you to put away both the completed picking works to the

outbound staging location.

9. Select OKOK.

You receive a "Work Completed" message.

10. Enter the second work ID for sales order 1.

There is only one pick task for this work ID.

11. Select OKOK.

The Sales orders: PickSales orders: Pick  task page shows the item number, quantity, and location to pick from.

12. In the LPLP field, enter the license plate number for the item in the location that is shown.

The license plate that you specify will be one of the system-generated license plates from the

replenishment work tasks. To make sure that you capture the correct license plate ID, check the inventory

on the On-hand listOn-hand list page for the item, location, and quantity.

13. Select the OKOK button (check mark symbol).

14. Confirm the instructions for the put task to the outbound staging location.

15. Select OKOK.

You receive a "Work Completed" message.

Sales order 2 is blocked from picking because the replenishment task that it's linked to isn't completed.

Currently, there is still a quantity of 30 ea in the picking location, and the replenishment quantity for sales order

2 is 60 ea. The sum of the on-hand inventory and the replenishment inventory (90 ea) exceeds the overflow

quantity of 0.65 PL (or 65 ea). Before the replenishment work can be completed, sales order 3 must be picked.



1. Enter the work ID for sales order 3.

There is only one pick task for this work ID.

2. Select OKOK.

The Sales orders: PickSales orders: Pick  task page shows the item number, quantity, and location to pick from.

3. In the LPLP field, enter the license plate number for the item in the location that is shown.

The license plate that you specify will be one of the system-generated license plates from the

replenishment work tasks. To make sure that you capture the correct license plate ID, check the inventory

on the On-hand listOn-hand list page for the item, location, and quantity.

4. Select the OKOK button (check mark symbol).

5. Confirm the instructions for the put task to the outbound staging location.

6. Select OKOK.

You receive a "Work Completed" message.

As soon as the sum of the on-hand quantity in the picking location and the replenishment quantity is below the

threshold, you will be able to process the remaining replenishment work.

Return to the Work detailsWork details  page, and notice that the replenishment work availability for the final piece of

replenishment (for sales order 2) is Open, because there is now enough space in the location to accept the

replenishment.

You can now process this replenishment work via the mobile device.

1. Go to Inventor y > ReplenishmentInventor y > Replenishment.

You're prompted to complete the remaining replenishment work. The item number, quantity, and location

to pick from are shown.

2. In the LPLP field, enter the license plate number for the item in the location that is shown.

3. Select the OKOK button (check mark symbol).

The system generates a target license plate number for the new license plate for the picked item.

4. Select OKOK to confirm the value.

Put work is shown that instructs the user to put the target license plate into the replenishment location.

The Put location should be 06A01R2S1B06A01R2S1B.

5. Confirm the put details, and select OKOK.

You receive "Work Completed" and "No Work Available" messages.

You can now pick sales order 2. It became unblocked when the replenishment work that is linked to the sales

order was completed.

1. Enter the work ID for sales order 2.

There is only one pick task for this work ID.

2. Select OKOK.

The Sales orders: PickSales orders: Pick  task page shows the item number, quantity, and location to pick from.

3. In the LPLP field, enter the license plate number for the item in the location that is shown.



Notes and tips

NOTENOTE

The license plate that you specify will be the system-generated license plate from the replenishment work

task. To make sure that you capture the correct license plate ID, check the inventory on the On-hand listOn-hand list

page for the item, location, and quantity.

4. Select the OKOK button (check mark symbol).

5. Confirm the instructions for the put task to the outbound staging location.

6. Select OKOK.

You receive a "Work Completed" message.

This functionality works with all types of replenishment: wave demand, min/max, load demand, and slotting.

You can manually override the replenishment work availability for each work header from the Work detailsWork details

page if you want.

When the system sets the replenishment work availability, it considers any inventory that is already in the

location before any work is completed

Each piece of sales order work is linked to a specific replenishment work. There is no corresponding sales

work availability functionality.
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I receive the following error message: "Work %1 cannot be unblocked
because it has unfinished replenishment work."
Issue descriptionIssue description

Issue resolutionIssue resolution

NOTENOTE

This topic describes how to fix common issues that you might encounter while you work with warehouse

replenishment in Microsoft Dynamics 365 Supply Chain Management.

Picking work is blocked because of dependent replenishment work.

When you use wave demand replenishment, if a picking location must be replenished to fulfill the source order

demand, the system creates both the replenishment work and the picking work. However, it blocks the picking

work until the replenishment work is completed. This behavior is intentional, because the picking location won't

have enough inventory unless the replenishment work is completed. Complete the replenishment work, and

then process the picking work.
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The Confirm and transfer feature lets users ship loads out of the warehouse before they complete all the work

that is associated with those loads. When a shipment is received that includes load lines that weren't fully picked,

the confirming user is prompted either to split the remaining quantities onto a new load or to cancel the

incomplete quantities.

Systems that are set up to allow load splitting support scenarios where planned and partially loaded loads must

be adapted because of new or changing circumstances.

The client includes logic that enables a partially loaded load to be closed and confirmed as shipped. All

remaining shipments and load lines (including full or partial line quantities) are then rolled over to a newly

created load and shipment, if this rollover is required and the setup allows for it. New shipments and loads are

automatically created based on the initial criteria for shipment and load creation, and their main attributes

remain unchanged. There is also an option to automatically cancel remaining quantities if a work order hasn't

yet been created and the user deems this cancellation necessary.

This functionality supports scenarios where the full load doesn't fit onto a single truck, or where some of the

load should leave the warehouse before the rest of the load is ready for shipment. In these scenarios, the

remaining products can be transferred to a new load and therefore to a new truck. Because this feature can be

used with loads that are otherwise intended to require full-load shipment, it provides extra flexibility so that

transport managers can solve nonstandard or unforeseen scenarios.

When a load is split, the Confirm and transfer feature performs the following actions:

New loads and shipments are created as they are required. Each load or shipment will have most of the same

attributes as the original load or shipment. The exception is the load status, which will be recalculated based

on the work status.

The user is informed that a new load has been created. The user is also notified about the ID of the new load.

The load lines, work headers, and work lines that were split are updated with the new load and shipment

information.

If a whole shipment is being split, the shipment is maintained, and only the load references are updated. If

the shipment must be split, a new shipment is created.

When remaining quantities are canceled, any load line quantities that haven't been picked and that don't have

non-canceled work associated with them are removed from the load. If any work is in process, the user can only

split the load. Remaining quantities can't be canceled.

You can split only loads that meet all the following criteria:

One or more load lines have picked quantities.

The load status is less than loaded.

There is no load line data. (This data is created through license plate consolidation on the staging location,

and the Confirm and transfer feature doesn't support license plate consolidation.)

No inventory is currently awaiting packing at a packing location. (The Confirm and transfer feature doesn't

support inventory that has been picked to the pack station but hasn't yet been packed.)

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/confirm-and-transfer.md


NOTENOTE

Turn on confirm and transfer

Set up confirm and transfer

Prepare your load templatesPrepare your load templates

Prepare your work templatesPrepare your work templates

This functionality differs from the transport load functionality, which should be used in warehouses that can never plan

and create loads before picking, but that instead load the available transportation space after picking is completed.

Use the Confirm and transfer feature in situations where loads are usually planned and created ahead of time, but where

exceptions sometimes occur in which the load doesn't fit the available transport (such as a truck).

Before you can use the Confirm and transfer feature, it must be turned on in your system. Admins can use the

feature management settings to check the status of the feature and turn it on if it's required. In the FeatureFeature

managementmanagement workspace, the feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Confirm and transfer

To use the Confirm and transfer feature, you must turn it on in every relevant load template. In addition,

depending on your requirements, you might want to prepare your work templates to support the feature. If you

want to work through the example scenario that is provided later in this topic, set up your system as described

in this section. (That scenario is based on USMFUSMF demo data.)

1. Go to Warehouse management > Setup > Load > Load templatesWarehouse management > Setup > Load > Load templates .

2. On the Action Pane, select EditEdit to put the page into edit mode.

3. Select the Allow load split during ship confirmAllow load split during ship confirm check box for each existing template where you want to

turn on the feature. Alternatively, select NewNew  to create a new template, and configure it as you require. Every

load that you create by using that template will inherit this functionality. (If you're working with the USMFUSMF

demo data, turn on the feature for the 20' Container20' Container  load template.)

This setup isn't required in all situations. The example that is shown here ensures that work can be broken by

shipment to support the example scenario that is provided later in this topic. There are also other ways to

achieve this result.

1. Go to Warehouse management > Setup > Work > Work templatesWarehouse management > Setup > Work > Work templates .

2. In the grid in the upper part of the page, select an existing work template where you want to set up the

Confirm and transfer feature. (If you're working with the USMFUSMF demo data, select the 51 Pick to stage51 Pick to stage

work template.) Alternatively, create a new work template.

3. On the Action Pane, select Edit quer yEdit quer y  to open the SalesSales  dialog box.

4. In the SalesSales  dialog box, on the Sor tingSor ting tab, select AddAdd to add a row to the grid.

5. In the new row, set the following values:

Table:Table: Temporary work transactions

Derived table:Derived table: Temporary work transactions

Field:Field: Shipment ID

Search direction:Search direction: Ascending

6. Select OKOK to save your settings and close the SalesSales  dialog box.



Scenario
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Step 1: Create a load that has multiple load linesStep 1: Create a load that has multiple load lines

7. If you receive a message that states that grouping will be reset, select YesYes  to continue.

8. In the grid in the upper part of the Work templatesWork templates  page, select the template that you just edited, and

then, on the Action Pane, select Work header breaksWork header breaks .

9. On the Action Pane, select EditEdit to put the page into edit mode.

10. In the grid, set the following values:

Table name:Table name: Temporary work transactions

Field name:Field name: Shipment ID

Group by this field:Group by this field: Select this check box.

11. On the Action Pane, select SaveSave.

12. Close the page.

This scenario shows an example where the picking process isn't yet completed, but the items that have been

picked so far must be loaded onto a truck and shipped anyway. Therefore, the user can split the unpicked load

lines onto a new load. All the data relationships will then automatically be updated.

The specific values that are described in this scenario are based on the USMFUSMF demo data. We recommend that you use

this demo data while you're demonstrating or learning how to use the feature. If you aren't using the USMFUSMF demo data,

substitute your own values as required.

Before you can use this functionality, you must have a load that contains multiple load lines. You must also make

sure that the pick locations have enough inventory for all the items on the sales orders that you will create.

Review the setup of the location directive (Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives ), and

make a note of the picking locations that are used for sales order picking. If you must adjust the inventory,

create manual movements, use replenishment, or use any other flow, as required.

To create a qualifying load, first create three sales orders by following these steps.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. On the Action Pane, select NewNew  to open the Create sales orderCreate sales order  dialog box.

3. In the Create sales orderCreate sales order  dialog box, set the following values (at a minimum):

On the CustomerCustomer  FastTab, set the Customer accountCustomer account field to US-004 (Cave Wholesales).

On the GeneralGeneral  FastTab, set the WarehouseWarehouse field to 51.

4. Select OKOK to create the sales order and close the Create sales orderCreate sales order  dialog box.

5. Your new sales order is opened. In the Sales order linesSales order lines  grid, add a line that has the following values:

Item number :Item number : M9200

Quantity:Quantity: 40

Unit:Unit: ea

6. On the Inventor yInventor y  menu above the grid, select Reser vationReser vation.

7. On the Action Pane, select Reser ve lotReser ve lot to open the Reser vationReser vation page.

8. Reserve the inventory on the sales line, and then close the Reser vationReser vation page.



Load planning workbenchLoad planning workbench

Step 2: Set up the execution flow for mobile devicesStep 2: Set up the execution flow for mobile devices

9. Repeat steps 1 through 4 to add a second sales order for the same customer and warehouse.

10. Add two sales lines that have the following values. After you add each line, reserve inventory for it as

described in steps 6 through 8.

L ine 1:L ine 1: Set the Item numberItem number  field to M9200, the QuantityQuantity  field to 30, and the UnitUnit field to ea.

L ine 2:L ine 2: Set the Item numberItem number  field to M9201, the QuantityQuantity  field to 20, and the UnitUnit field to ea.

11. Repeat steps 1 through 4 to add a third sales order for the same customer and warehouse.

12. Add two sales lines that have the following values. After you add each line, reserve inventory for it as

described in steps 6 through 8.

L ine 1:L ine 1: Set the Item numberItem number  field to M9201, the QuantityQuantity  field to 20, and the UnitUnit field to ea.

L ine 2:L ine 2: Set the Item numberItem number  field to M9202, the QuantityQuantity  field to 60, and the UnitUnit field to ea.

The load planning workbench will use the load template ID to build the shipments and release the sales order

lines to the warehouse.

1. Go to Warehouse management > Loads > Load planning workbenchWarehouse management > Loads > Load planning workbench.

2. In the WarehouseWarehouse field, select 51.

You will now build the load for the sales orders that you just created.

3. On the Sales linesSales lines  tab, in the grid, select the sales lines for the new sales orders.

4. On the Action Pane, on the Supply and demandSupply and demand tab, in the AddAdd group, select To new loadTo new load.

5. In the Load template assignmentLoad template assignment dialog box, in the Load template IDLoad template ID field, select 20' Container.

6. Select OKOK.

7. In the LoadsLoads  section of the Load planning workbenchLoad planning workbench page, in the grid, find the newly created load ID

for warehouse 51. Scroll right until you see the Allow load split during ship confirmAllow load split during ship confirm column. The

check box should be selected for your load.

8. Select the load.

9. On the ReleaseRelease menu above the grid, select Release to warehouseRelease to warehouse to create work.

10. In the Release load to warehouseRelease load to warehouse dialog box, verify that the Records to includeRecords to include FastTab shows your

load ID.

11. Select OKOK.

You might receive a "Processing operation" message while the system creates the shipments and work.

12. In the LoadsLoads  section of the Load planning workbenchLoad planning workbench page, your load should now have a load status

of Waved. Select the load, and then, on the Related informationRelated information menu above the grid, select WaveWave

detailsdetails  to view the shipment IDs that were created. When you've finished, close the WavesWaves  page.

13. In the LoadsLoads  section of the Load planning workbenchLoad planning workbench page, select the load, and then, on the RelatedRelated

informationinformation menu above the grid, select Work detailsWork details  to view the work that was created for the sales

orders.

14. Make a note of the work IDs that were created. You might have to scroll right to see the sales order

number and shipment ID that are associated with the work ID.

Mobile device tasks will require user input of information, such as the work ID or license plate ID. In the fields,



Step 3: Confirm the outbound shipmentStep 3: Confirm the outbound shipment

this information is typically provided for warehouse users in the form of bar codes that are found on

documentation, packaging, or racking. To complete the mobile device steps for scenarios, make sure that you've

identified the work IDs for the transactions, and the license plate IDs for the item and location in the

transactions.

1. Sign in to the mobile device by using a user ID and password for warehouse 51.

2. Select OutboundOutbound.

3. Select Sales PickingSales Picking.

4. You have the option to enter the work ID or the license plate ID. Enter the work ID for the first sales order,

and then select EnterEnter .

5. In the LocLoc field, enter the location that is shown to confirm the picking location. Then select EnterEnter .

6. In the LPLP field, enter the license plate ID. The license plate ID must be a match for the item, warehouse,

and location of the item that is being picked from the selected location. When you've finished, select

EnterEnter .

7. In the ItemItem field, enter the item number to confirm the item that is being picked, and then select EnterEnter .

8. In the QtyQty  field, enter the quantity of the item that is being picked, and then select EnterEnter .

9. In the Target LPTarget LP field, enter a target license plate ID. Target license plates are user-defined. Be sure to

enter a license plate ID that you will remember. We recommend that you use the current date plus a two-

digit sequence (YYMMDD##) as the format, such as 19112301. When you've finished, select EnterEnter .

10. Review information that is shown. This information is the Pick information that will now become the Put

data for the put transaction. When you've finished, select EnterEnter .

You receive a Work CompletedWork Completed message.

11. Repeat steps 4 through 10 for the work ID of the second sales order.

The next step is to load the two picked license plates to the truck.

1. Sign in to the mobile device by using a user ID and password for warehouse 51.

2. Select OutboundOutbound.

3. Select Sales LoadingSales Loading.

4. Enter the user-defined target license plate ID that you created for the first work ID in the previous procedure.

Then select EnterEnter  to put the target license plate into the STAGESTAGE location.

5. Enter the target license plate ID again, and then select EnterEnter  to put the license plate into the BAYDOORBAYDOOR

location.

6. Repeat steps 4 through 5 for the target license plate ID that you created for the second work ID.

The two work IDs will now be closed (loaded).

In this step, you will confirm the two sales orders and work that have been completed for the load to ship the

picked items of the load and create a new load for the unpicked items. Outbound shipment confirmation must

be done on the Load detailsLoad details  page.

1. Go to Warehouse management > Loads > Load planning workbenchWarehouse management > Loads > Load planning workbench.

2. In the LoadsLoads  section, in the grid, select the row for the load ID that you created.

3. Select the load ID link to open the Load detailsLoad details  page.

4. On the Load detailsLoad details  page, on the Action Pane, on the Ship and receiveShip and receive tab, in the ConfirmConfirm group,
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select Outbound shipmentOutbound shipment to initiate the confirmation.

5. In the Ship confirmShip confirm dialog box, in the Load split method during ship confirmLoad split method during ship confirm field, select Split

quantity to new load.

6. Select OKOK.

You might receive a "Processing operation" message.

You receive informational messages that indicate that the shipment for your load has been confirmed,

and that a new load has been created from the split quantity.

Refresh the Load planning workbenchLoad planning workbench page to see the newly created load.

You can also confirm that transaction relations have been updated in the following ways:

The remaining (unprocessed) shipment and shipment lines are updated with the new load ID.

The sales order is linked to the new load ID.

The original load doesn't include the remaining load lines.

The remaining work has been updated with the new load ID.

The wave remains the same.

The status of the new load is correctly updated. (If the work status is In process, the load status should also be

In process.)

You can also turn on the Allow load split during ship confirmAllow load split during ship confirm parameter after the load has been created

with the Load templateLoad template parameter turned off but before the loading process has started. Go to the desired

load, and then, in the header view, turn on the parameter.

The Split quantity to new loadSplit quantity to new load option also works when some of the remaining work headers have a

status of In process. Therefore, you can still use the functionality even if workers are already running the pick

orders.

If you select Cancel unfulfil led quantityCancel unfulfil led quantity  while there is remaining work that has a status of Open or In

progress, you receive the following error message: "Unable to cancel remaining qty for load. Work exists for

load."

If you select Cancel unfulfil led quantityCancel unfulfil led quantity  when there is no remaining work but there are unreleased load

lines on the load, you receive the following error message: "The shipment for load could not be confirmed

because the quantity for item exceeds the percentage that is defined for under delivery." To avoid the error,

you can set the Under deliver yUnder deliver y  percentage on the unreleased load line to 100 percent. Unreleased lines

won't be moved to a new load, but the current load will be confirmed with under-delivery. In this case, you

won't be able to re-release the original order. Therefore, so you will have to handle it in some other way.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Confirm outbound shipments from batch jobs
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Enable the Confirm outbound shipments from batch jobs feature

Process outbound shipments

NOTENOTE

This topic describes how to set up a batch job that automatically confirms outbound transfer-order shipments

for ready-to-ship loads. The batch job described here only applies to transfer order shipments, not to sales

orders.

Before you can use this feature, it must be enabled on your system. Administrators can use the Feature

management page to check the feature status and enable it if needed. The feature is listed as:

ModuleModule - Warehouse management

Feature nameFeature name - Confirm outbound shipments from batch jobs

To set up a scheduled batch job to run the outbound shipment confirmation for loads that are ready to ship:

1. Go to Warehouse management > Periodic tasks > Process outbound shipmentsWarehouse management > Periodic tasks > Process outbound shipments .

2. The Confirm shipmentConfirm shipment dialog box opens. On the Records to includeRecords to include FastTab, select FilterFilter .

3. The query editor dialog box opens. On the RangeRange tab, add a row with the following values:

4. Select OKOK to return to the Confirm shipmentConfirm shipment dialog box.

5. On the Run in the backgroundRun in the background FastTab, set Batch processingBatch processing to YesYes .

6. On the Run in the backgroundRun in the background FastTab, select RecurrenceRecurrence.

7. The Define recurrenceDefine recurrence dialog box opens. Set the run schedule as needed for your business.

8. Select OKOK to return to the Confirm shipmentConfirm shipment dialog box.

9. Select OKOK on the Confirm shipmentConfirm shipment dialog box to add the batch job to the batch queue.

TableTable - Loads

Derived tableDerived table - Loads

FieldField - Load status

Criter iaCriter ia - Loaded

For more information, see Batch processing overview.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/confirm-outbound-shipments-from-batch-jobs.md
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/sysadmin/batch-processing-overview
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https://go.microsoft.com/fwlink/?LinkId=521839
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Turn on advanced wave load building in your system

Make sample data availableMake sample data available

Make sure that the scenario setup includes enough available inventoryMake sure that the scenario setup includes enough available inventory

Advanced wave load building automatically assigns shipments to existing waves during wave execution.

Therefore, you can create meaningful loads that represent trucks without having to use the load planning

workbench. This capability is useful for businesses that want to use the concept of loads to track and plan the

shipment of goods in a truck/trailer, but that don't want to manually create those loads every day.

During wave processing, the system usually creates a new load for each shipment that no load is assigned to.

However, when advanced wave load building is turned on, the system assigns each unassigned shipment to an

existing load (if an appropriate load exists), and new loads are created only when they are required. Advanced

wave load building automatically creates the new loads, based on criteria that you define.

To use the feature, you must set up the system in the following way:

Create wave templates that include the new buildLoadsbuildLoads  method. This method makes advanced wave load

building available for waves that use those templates.

Set up load build templates, each of which is linked to a specific wave template and method. Load build

templates control which load (existing or new) the load lines that are being waved are added to. You can

combine or separate shipments, based on criteria such as the load template, equipment, and other field

values on the load line.

Define load mix groups to control which items should and should not be combined on a single load. You also

specify whether the restriction should produce a warning or an error, and whether the volumetric restriction

of the load template should be evaluated.

Before you can use advanced wave load building, two features must be turned on in your system. Admins can

use the feature management settings to check the status of these features and turn them on if they are required.

In the Feature managementFeature management workspace, the features are listed in the following way:

Wave load building feature:

Module:Module: Warehouse management

Feature name:Feature name: Wave load building feature

Organization wide wave step code:

Module:Module: Warehouse management

Feature name:Feature name: Organization wide wave step code

To work through this demo by using the sample records and values that are specified here, you must be on a

system where the standard demo data is installed. Additionally, you must select the USMFUSMF legal entity before

you begin.

You can also use this demo as guidance for using this feature when you work on a production system. However,

in that case, you must substitute your own values, and you might be missing some types of required records

that the standard demo data provides.

If you're working with the USMFUSMF demo data, you must first make sure that your system is set up so that there is

enough inventory at each relevant location. For this demo, the expectation is that the following inventory is

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/advanced-load-building-during-wave.md


Create a new license plate IDCreate a new license plate ID

Create a standard cost for item M9200 in site 6Create a standard cost for item M9200 in site 6

Create inventory in warehouse 62Create inventory in warehouse 62

available in warehouse 62:

Item A0001:Item A0001: 10 pcs

Item A0002:Item A0002: 10 pcs

Item M9200:Item M9200: 10 ea

Item M9200M9200  must be added to the warehouse. Complete the procedures in the following subsections to add the

item inventory.

1. Go to Warehouse managementWarehouse management > SetupSetup > WarehouseWarehouse > L icense platesLicense plates .

2. On the Action Pane, select NewNew .

3. In the new row, in the L icense plateLicense plate field, enter LP6203.

4. Select SaveSave.

1. Go to Product information managementProduct information management > ProductsProducts  > Released productsReleased products .

2. Search on M9200M9200 .

3. Select the row for the item, and then, on the Action Pane, on the Manage costsManage costs  tab, in the Set upSet up group,

select Item priceItem price.

4. On the Item priceItem price page, select the Pending pr icesPending pr ices  tab.

5. On the Action Pane, select NewNew .

6. On the new line, set the following values:

Costing type:Costing type: Planned cost

Pr ice type:Pr ice type: Cost

Version:Version: 10

Site:S ite: 6

Pr ice:Pr ice: 1.60

7. On the Action Pane, select SaveSave.

8. On the Action Pane, select Activate pending pr ice(s)Activate pending pr ice(s) .

9. Select the Active pr icesActive pr ices  tab to verify that the new cost price for site 6 has been added.

1. Go to Inventor y managementInventor y management > Journal entr iesJournal entr ies  > ItemsItems > Inventor y adjustmentInventor y adjustment.

2. On the Action Pane, select NewNew .

3. In the Create inventor y journalCreate inventor y journal  dialog box, on the Over viewOver view  FastTab, in the WarehouseWarehouse field, enter

62. Accept the default values in all the other fields.

4. Select OKOK to close the dialog box.

5. The Inventor y adjustmentInventor y adjustment page is opened. On the Journal linesJournal lines  FastTab, select NewNew  to add a line.

6. On the new line, set the following values. Accept the default values in all the other fields.

Item number :Item number : M9200

Location:Location: bulk-003

Quantity:Quantity: Change the value to 10.

7. On the Action Pane, select SaveSave.



Set up advanced wave load building
Regenerate wave process methodsRegenerate wave process methods

Set up wave templatesSet up wave templates

8. On the Action Pane, select ValidateValidate to check for errors.

9. In the Check journalCheck journal  dialog box, select OKOK to start the check. You receive a message when the check is

completed.

10. On the Action Pane, select PostPost to commit the inventory adjustment.

11. In the Post journalPost journal  dialog box, select OKOK to start the posting. You receive a message when the posting is

completed.

You might have to regenerate your wave process methods to make the load building method (buildLoadsbuildLoads )

available.

1. Go to Warehouse managementWarehouse management > SetupSetup > WavesWaves  > Wave process methodsWave process methods .

2. Verify that buildLoadsbuildLoads  is present in the list. If it isn't present, select Regenerate methodsRegenerate methods  on the Action

Pane to add it.

To take advantage of advanced wave load building, you must include the buildLoadsbuildLoads  method in each relevant

wave template.

1. Go to Warehouse managementWarehouse management > SetupSetup > WavesWaves  > Wave templatesWave templates .

2. Select a wave template.

If you're working with the USMFUSMF demo data, select the 62 Shipping Default62 Shipping Default template.

3. On the Action Pane, select EditEdit to put the page into edit mode.

4. On the MethodsMethods  FastTab, in the Remaining methodsRemaining methods  grid, select the buildLoadsbuildLoads  method.

5. Select the right arrow button to move the buildLoadsbuildLoads  method to the Selected methodsSelected methods  grid.

6. To assign a Wave step codeWave step code value for the buildLoadsbuildLoads  method, you must first create a code on the

Wave step codesWave step codes  page. You can use any value that you want, but be sure to make a note of it, because

you will need it later. Follow these steps to create code WSC2112WSC2112 :

a. In the row for the buildLoadsbuildLoads  method, right-click the down arrow in the Wave step codeWave step code field, and

then select View detailsView details .

b. On the Wave step codesWave step codes  page, on the Action Pane, select NewNew .

c. In the Wave step codeWave step code field, enter WSC2112.

d. In the Wave step descr iptionWave step descr iption field, enter WSC2112.

e. In the Wave step typeWave step type field, select Load Building.

7. Select SaveSave, and close the page.

8. In the row for the buildLoadsbuildLoads  method, in the Wave step codeWave step code field, select the code that you just created

(WSC2112WSC2112 ).

9. On the Action Pane, select SaveSave.
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Set up load mix groupsSet up load mix groups

Set up load build templatesSet up load build templates

Wave step codes are codes that users can set up and use to link specific instances of wave methods to corresponding

templates. The templates include templates for replenishment, containerization, label printing, load building, and sorting.

When wave step codes aren't used, users must enter free text to reference a specific template from the wave method

instance. Free text is prone to errors, because users must make sure that the wave step text that they add for a specific

wave step method in a wave template exactly matches the wave step text in the target template.

Wave step codes for a specific wave step type are set up on a separate page. For every instance of a wave step method in

a wave template that requires a wave step code, the wave step code must be selected in a drop-down list. Selection in a

drop-down list replaces free text entry and helps reduce the risk and impact of human error. Setup codes are used to link

a wave step method in a wave template to a target template for the method.

Load mix groups establish rules for the types of items that can be combined on a single load. You can set up as

many load mix groups as you require. However, to use advanced wave load building, you must have at least one.

Follow these steps to create a load mix group.

1. Go to Warehouse managementWarehouse management > SetupSetup > LoadLoad > Load mix groupsLoad mix groups .

2. On the Action Pane, select NewNew  to create a load group.

3. In the Load mix group IDLoad mix group ID field, enter a name for the new group.

If you're working with the USMFUSMF demo data, set the following values:

Load mix group ID:Load mix group ID: TV

Descr iption:Descr iption: TV

4. On the Action Pane, select SaveSave to make the Load mix group cr iter iaLoad mix group cr iter ia FastTab available.

5. On the Load mix group cr iter iaLoad mix group cr iter ia FastTab, select NewNew  to add a row to the grid.

6. In the new row, set the desired values in each field. These values determine the item groups that are

considered for the load mix.

If you're working with the USMFUSMF demo data, select TV&Video in the Item groupItem group field.

7. On the Action Pane, select SaveSave to make the Load mix group constraintsLoad mix group constraints  FastTab available.

8. On the Load mix group constraintsLoad mix group constraints  FastTab, select NewNew  to add a row to the grid.

9. In the new row, set the desired values in each field.

If you're working with the USMFUSMF demo data, set the following values:

Item group:Item group: CarAudio

Load build action:Load build action: Restrict (This value will prevent items that belong to the CarAudioCarAudio item group

from being on the same load as items that belong to the TV&VideoTV&Video item group.)

10. Continue to work with the rules until you've added all the criteria and constraints that you require for the

load mix group.

If you're working with the USMFUSMF demo data, you've now finished this setup.

You can set up as many load build templates as you require. However, to use advanced wave load building, you

must have at least one. Follow these steps to create a load build template.

1. Go to Warehouse ManagementWarehouse Management > SetupSetup > LoadLoad > Wave load building templatesWave load building templates .



F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N VA L UE IN  T H E USM F  DEM O  DATAVA L UE IN  T H E USM F  DEM O  DATA

Sequence number The order that the template will be
evaluated in.

1

Load build template name Enter the unique identifier of the
load build template. You should
enter the name of the template that
you created or updated earlier in
this setup.

62 Shipping Default

Wave step code Enter the wave step code to use to
link the template to a wave method.
You should enter the code that you
selected for the buildLoadsbuildLoads
method when you set up the wave
template earlier in this setup.

WSC2112

Load template ID Select the load template to use
when new loads are created and to
match against when assigning to
existing loads. The load template
defines the maximum weight and
volume that are permitted for the
whole load.

Stnd Load Template

Equipment The equipment to match against
when assigning to existing loads
and to enter on new loads that are
created.

Leave this field blank.

Load mix group ID Select the load mix group to use if
the item is allowed on the load. The
mix group establishes rules for the
types of items that can be combined
on a single load. You should select
one of the mix groups that you
created earlier in this setup.

TV

Use open loads Select whether existing open loads
should be added. The following
options are available:

Any

Create loads Specify whether new loads should
be created if no existing loads match
the criteria.

Selected (= Yes)

2. On the Action Pane, select NewNew  to add a row to the grid.

3. In the new row, set the following values.

NoneNone – Don't add open
loads to any existing loads.

AnyAny – Add open loads to
any existing loads that are
valid for the line.

AssignedAssigned – Add open loads
to the load that is assigned
to the wave.



Scenario

Create sales ordersCreate sales orders

Allow shipment line split Specify whether a single load line
can be split across multiple loads if
the full line exceeds the maximum
capacity of the load template.

Cleared (= No)

Validate volumetrics Specify whether load building
should check the weight and
volume as each load line is added,
to ensure that the volumetric limits
of the load template are respected.

Cleared (= No)

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N VA L UE IN  T H E USM F  DEM O  DATAVA L UE IN  T H E USM F  DEM O  DATA

4. On the Action Pane, select SaveSave to make the Edit quer yEdit quer y  option available.

5. On the Action Pane, select Edit quer yEdit quer y  to open a dialog box for editing the query.

6. In the dialog box, on the Sor tingSor ting tab, select AddAdd to add a row to the grid.

7. In the new row, define the sorting rules that you want to use. For example, set the following values to sort

the search results in ascending order by order number:

Table:Table: Load details

Derived table:Derived table: Load details

Field:Field: Order number

Search direction:Search direction: Ascending

8. Select OKOK to save your changes and close the dialog box.

9. On the Break byBreak by  FastTab, set rules to control how your loads are split up. Typically, you might break on

custom fields that have been extended onto the load line, such as RouteRoute, TourTour , or RunRun. For example, to

create one load per order number, select the Break byBreak by  check box for the row that has the following

values:

Reference table name:Reference table name: Load details

Reference field name:Reference field name: Order number

This scenario shows how the settings that were described earlier in this topic affect warehouse operations while

a sales order is processed. This scenario uses the USMFUSMF demo data together with other demo values that are

provided in those setup instructions.

1. Go to Sales and marketingSales and marketing > Sales ordersSales orders  > All sales ordersAll sales orders .

2. On the Action Pane, select NewNew  to open the Create sales orderCreate sales order  dialog box.

3. In the dialog box, set the following values:

On the CustomerCustomer  FastTab, set the Customer accountCustomer account field to US-007.

On the GeneralGeneral  FastTab, set the WarehouseWarehouse field to 62.

4. Select OKOK to create the sales order and close the dialog box.

5. Your new sales order is opened. It should include a new, empty line in the grid on the Sales order linesSales order lines

FastTab. On this new line, set the Item numberItem number  field to A0001 and the QuantityQuantity  field to 1.

6. On the Inventor yInventor y  menu above the grid, select Reser vationReser vation.



NOTENOTE

7. On the Reser vationReser vation page, on the Action Pane, select Reser ve lotReser ve lot.

8. Select the CloseClose button (XX) in the upper-right corner of the page to return to the sales order.

9. On the Action Pane, on the WarehouseWarehouse tab, in the ActionsActions  group, select Release to warehouseRelease to warehouse. The

system creates a shipment and adds it to a new load, because no existing load contains load lines that

have this order number.

You receive informational messages that indicate the work, wave, and shipment that are created for this

order.

10. To confirm the load, shipment, and work details on the sales line, select the line, and then, on the

WarehouseWarehouse menu above the grid, select Load detailsLoad details , Shipment detailsShipment details , or Work detailsWork details .

11. In the sales order that you just created, on the Sales order linesSales order lines  FastTab, select Add lineAdd line to add another

line.

12. On the new line, set the Item numberItem number  field to A0002 and the QuantityQuantity  field to 1.

13. Repeat lines 6 through 9 to reserve the line and release it to the warehouse. The system creates a newnew

shipment for the line that you added. However, because you're using advanced wave load building, the

system adds that shipment and load line to the existing wave. If you weren't using advanced wave load

building, the system would create a new load for the shipment.

14. In the sales order that you just created, on the Sales order linesSales order lines  FastTab, select Add lineAdd line to add another

line.

15. On the new line, set the Item numberItem number  field to M9200 and the QuantityQuantity  field to 1.

16. Repeat lines 6 through 9 to reserve the line and release it to the warehouse. As before, the system creates

a newnew  shipment for the line that you added. However, because the item is from the CarAudioCarAudio item

group, it fails to pass the constraints that you set up for the load mix groupfails to pass the constraints that you set up for the load mix group. Therefore, it's

added to a new loadadded to a new load. If you hadn't specified a load mix group on the load build template, this shipment

would have been added to the first load.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Release to warehouse rule
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Turn on and initialize the Release to warehouse rule feature
Turn on the featureTurn on the feature

Initialize the featureInitialize the feature

Set the release to warehouse rule for each warehouse

The Release to warehouse rule feature provides flexibility during release to the warehouse. It adds a

configuration option for each warehouse. You can use this option to specify whether partially reserved order

lines can be released for that warehouse. The feature works together with advanced cross-docking functionality

in situations where part of an order line quantity is marked against a supply source, but the remaining part can

be processed in the warehouse. Therefore, the line can be released so that warehouse processing of the

available inventory quantity can continue.

Before you can use the Warehouse release rule feature, it must be turned on in your system. Admins can use the

feature management settings to check the status of the feature and turn it on if it's required. In the FeatureFeature

managementmanagement workspace, the feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Warehouse release rule

After the feature is turned on in your system, you must initialize it to set the rule to the correct initial state for all

warehouses.

For warehouses that aren't enabled for warehouse management, the rule is initially set to Not applicableNot applicable.

For warehouses that are enabled for warehouse management, the rule is initially set to Allow par tialAllow par tial

reser vationreser vation

To initialize the feature and set the release to warehouse rule for all warehouses, follow these steps.

1. Go to Warehouse management > Setup > Warehouse management parametersWarehouse management > Setup > Warehouse management parameters .

2. On the Warehouse management parametersWarehouse management parameters  page, on the GeneralGeneral  tab, in the Company informationCompany information

section, select the link for the Initialize release to warehouseInitialize release to warehouse rule. (If this link isn't shown, either the

feature isn't turned on or it has already been initialized.)

3. When you're prompted to confirm the action, select YesYes  to initialize the feature.

After the feature is turned on and initialized, all your warehouses will have an initial setting, as described in the

previous section. You can change this setting for individual warehouses by following these steps.

1. Go to Warehouse management > Setup > Warehouse > WarehousesWarehouse management > Setup > Warehouse > Warehouses .

2. Select the warehouse to configure.

3. Select EditEdit to put the page into edit mode.

4. On the WarehouseWarehouse FastTab, in the Reser vationsReser vations  section, the Requirement for inventor yRequirement for inventor y

reser vationreser vation field controls whether partial release of orders is allowed. Select one of the following

values:

Not applicableNot applicable – When the feature is first turned on and initialized, this value is automatically

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/release-to-warehouse-rule.md


    

Scenarios

Make sample data availableMake sample data available

Scenario 1: Require full release (no planned cross-docking)Scenario 1: Require full release (no planned cross-docking)

assigned to all warehouses that aren't enabled for warehouse management. It can't be changed. This

value isn't available for warehouses that are enabled for warehouse management.

Allow par tial reser vationAllow par tial reser vation – Orders can be released when any quantity is reserved. The system will

evaluate whether the unreserved quantity should be marked for advanced cross-docking and will

mark that quantity as required. If no marking exists, the system will create work only for the reserved

quantity. When the feature is first turned on and initialized, this value is automatically assigned to all

warehouses that are enabled for warehouse management. This value isn't available for warehouses

that aren't enabled for warehouse management.

Require full reser vationRequire full reser vation – Orders can be released only if the whole quantity is reserved. They can't

be released if the total quantity isn't either physically reserved or planned for cross-docking. This

value isn't available for warehouses that aren't enabled for warehouse management.

5. Select SaveSave.

This section provides two scenarios that you can work through to learn what the feature does and how to use it.

To work through these scenarios by using the sample records and values that are specified here, you must be on

a system where the standard demo data is installed. Additionally, you must select the USMFUSMF legal entity before

you begin.

You can also use these scenarios as guidance for the feature when you work on a production system. However,

in that case, you must substitute your own values, and you might be missing some types of required records

that the standard demo data provides.

This scenario shows how the feature works for warehouses that are set to Require full reser vationRequire full reser vation.

1. Go to Warehouse management > Setup > Warehouse > WarehousesWarehouse management > Setup > Warehouse > Warehouses .

2. For warehouse 62, set the Requirement for inventor y reser vationRequirement for inventor y reser vation field to Require fullRequire full

reser vationreser vation, as described in the Set the release to warehouse rule for each warehouse section earlier in

this topic.

3. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

4. Select NewNew  to create a sales order.

5. In the Create sales orderCreate sales order  dialog box, set the following values:

On the CustomerCustomer  FastTab, set the Customer accountCustomer account field to US-004.

On the GeneralGeneral  FastTab, set the WarehouseWarehouse field to 62.

6. Select OKOK to create the new sales order and close the dialog box.

7. Your new sales order is opened. It includes an empty line in the grid in the Sales order linesSales order lines  section. On

this line, set the following values:

Item number :Item number : A0001

Quantity:Quantity: 2

8. Select Add lineAdd line to add a new line, and set the following values:

Item number :Item number : A0002

Quantity:Quantity: 2

9. Select the first order line, and then, on the Inventor yInventor y  menu above the grid, select Reser vationReser vation.



Scenario 2: Allow partial releaseScenario 2: Allow partial release

NOTENOTE

NOTENOTE

10. On the Reser vationReser vation page, select Reser ve lotReser ve lot to reserve the selected line's full quantity in the

warehouse.

11. Close the Reser vationReser vation page to return to the sales order.

12. Don't reserve the second order line.

13. On the Action Pane, on the WarehouseWarehouse tab, select Release to warehouseRelease to warehouse.

14. Notice that you receive the following error message: "The full quantity must be physically reserved."

Therefore, the system doesn't create any work, shipment, or load for the order.

You will receive the same error message if you partially reserve the second line.

This scenario shows how the feature works for warehouses that are set to Allow par tial releaseAllow par tial release.

1. Go to Warehouse management > Setup > Warehouse > WarehousesWarehouse management > Setup > Warehouse > Warehouses .

2. For warehouse 62, set the Requirement for inventor y reser vationRequirement for inventor y reser vation field to Allow par tialAllow par tial

reser vationreser vation, as described in the Set the release to warehouse rule for each warehouse section earlier in

this topic.

3. As you did in the previous scenario, go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders ,

and create a sales order for customer account US-004 from warehouse 62. Add the following two order

lines:

L ine 1:L ine 1: Set the Item numberItem number  field to A0001, the QuantityQuantity  field to 2, and the UnitUnit field to Pcs.

L ine 2:L ine 2: Set the Item numberItem number  field to A0002, the QuantityQuantity  field to 2, and the UnitUnit field to Pcs.

4. As you did in the previous scenario, reserve the full quantity for order line 1, but don't reserve order line

2.

5. On the Action Pane, on the WarehouseWarehouse tab, select Release to warehouseRelease to warehouse.

6. Notice that you don't receive an error message this time. Instead, the system creates work, shipments,

and loads as required, and shows the results.

7. To view the shipment, load, and work information, use the options on the WarehouseWarehouse menu above the

grid:

L ine 1:L ine 1: Three options are available: Shipment detailsShipment details , Load detailsLoad details , and Work detailsWork details . Select each

option to view the details of the shipment, load, and work that were created when the order was

released to the warehouse.

L ine 2:L ine 2: Only the Work detailsWork details  option is available. Select it, and notice that no work has been created,

because no inventory was reserved. Therefore, no shipment or load was created either.

The same result is expected when the second line is partially reserved. In this case, work will be created for the reserved

line quantity but not for the unreserved quantity.



NOTENOTE
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IMPORTANTIMPORTANT

Turn on the Wave template grouping feature

Set a wave template to use wave template grouping

Wave template grouping enables the system to use wave template setups to determine, based on criteria that

you define, how it should split released lines and assign them to new or existing waves. This feature can be

useful in warehouses where waves are created based on specific criteria, but where managers prefer to create

waves automatically instead of manually. It enables the system to add each newly released shipment to the first

wave that it finds that has matching grouping field values. If no match is found, the system creates a new wave

for the new shipment.

Wave template grouping isn't supported for the work types production raw material picking or Kanban picking. This is

because wave grouping is based on shipments and these work types don't use shipments.

Before you can use the Wave template grouping feature, it must be turned on in your system. Admins can use

the feature management settings to check the status of the feature and turn it on if it's required. In the FeatureFeature

managementmanagement workspace, the feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Wave template grouping

To make wave template grouping available, follow these steps to set up your wave template.

1. Go to Warehouse management > Setup > Waves > Wave templatesWarehouse management > Setup > Waves > Wave templates .

2. In the left pane, select the wave template to set up. If you're preparing to work through the scenario later

in this topic by using demo data, select the 62 Shipping default62 Shipping default template.

3. Select EditEdit to put the page into edit mode.

4. On the GeneralGeneral  FastTab, set the following values:

Automate wave creation:Automate wave creation: Yes

Assign to open waves:Assign to open waves: Yes

Process wave at release to warehouse:Process wave at release to warehouse: No

5. On the Action Pane, select Edit quer yEdit quer y  to open the query dialog box.

6. In the query dialog box, on the Sor tingSor ting tab, review the sorting criteria, and make sure that there is a rule

that includes the field that you want to use to group your waves.

If you're preparing to work through the scenario by using demo data, add a row that has the following

values:

Table:Table: Shipments

Derived table:Derived table: Shipments

Field:Field: Carrier service

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/wave-template-grouping.md


Scenario

Make sample data availableMake sample data available

Scenario: Wave template groupingScenario: Wave template grouping

Create sales order 1Create sales order 1

NOTENOTE
After you select this value, you might receive the following message: "Field Carrier service is not an index

field. Do you want to add sorting on this?" Select YesYes to add sorting.

Search direction:Search direction: Ascending

7. Select OKOK to save your changes and close the query dialog box.

8. On the Action Pane, select Wave template groupingWave template grouping.

9. On the Wave template groupingWave template grouping page, select the Group byGroup by  check box for each row that you want to

use to group your order lines into waves, as required. If you're preparing to work through the scenario by

using demo data, select the Group byGroup by  check box for the Carrier service row.

10. Select SaveSave.

11. Close the Wave template groupingWave template grouping page.

12. Select SaveSave to save your template.

This section provides a script that you can work through to learn what this feature does and how to work with it.

To work through this scenario by using the sample records and values that are specified here, you must be on a

system where the standard demo data is installed. Additionally, you must select the USMFUSMF legal entity before

you begin.

You can also use this scenario as guidance for using the feature when you work on a production system.

However, in that case, you must substitute your own values, and you might be missing some types of required

records that the standard demo data provides.

This scenario shows how to use wave template grouping to automatically create multiple waves, based on

grouping criteria that are defined in a wave template. In this scenario, the wave template is set up in the system

to create one wave per carrier service.

Before you begin, prepare your wave template as described in the Set a wave template to use wave template

grouping section earlier in this topic. If you will be working with demo data for this scenario, be sure to use the

demo data values that are suggested in that procedure. This setup will group your waves according to the

carrier service that is set for each sales order.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. Select NewNew  to create a sales order.

3. In the Create sales orderCreate sales order  dialog box, set the following values:

On the CustomerCustomer  FastTab, set the Customer accountCustomer account field to US-004.

On the GeneralGeneral  FastTab, set the WarehouseWarehouse field to 62.

4. Select OKOK to create the sales order and close the Create sales orderCreate sales order  dialog box.

5. The new sales order is opened in the L inesLines  view. Make a note of the sales order number.

6. Switch to the HeaderHeader  view.



View the wave that was created from sales order 1View the wave that was created from sales order 1

Create sales order 2Create sales order 2

7. On the Deliver yDeliver y  FastTab, in the Transpor tationTranspor tation section, set the following values:

Shipping carr ier :Shipping carr ier : Air cargo

Carr ier  ser vice:Carr ier  ser vice: Air

8. Switch back to the L inesLines  view.

9. In the Sales order linesSales order lines  section, select Add lineAdd line to add a line to the grid.

10. On the new line, set the following values:

Item number :Item number : A0002

Quantity:Quantity: 2

11. Select the new order line, and then, on the Inventor yInventor y  menu above the grid, select Reser vationReser vation.

12. On the Reser vationReser vation page, on the Action Pane, select Reser ve lotReser ve lot to reserve the full quantity of the

selected line in the warehouse.

13. Close the Reser vationReser vation page to return to the sales order.

14. On the Action Pane, on the WarehouseWarehouse tab, in the ActionsActions  group, select Release to warehouseRelease to warehouse.

15. You receive an informational message that shows the shipment and wave for this order. Make a note of

the wave ID number and the shipment ID numbers.

1. Go to Warehouse management > Outbound waves > Shipment waves > All wavesWarehouse management > Outbound waves > Shipment waves > All waves .

2. Select the wave ID that was created from the sales order.

3. Select the wave ID link to open the wave details page.

4. Notice that the shipment has been added to the Wave linesWave lines  FastTab.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. Select NewNew  to create a sales order.

3. In the Create sales orderCreate sales order  dialog box, set the following values:

On the CustomerCustomer  FastTab, set the Customer accountCustomer account field to US-005.

On the GeneralGeneral  FastTab, set the WarehouseWarehouse field to 62.

4. Select OKOK to create the sales order and close the Create sales orderCreate sales order  dialog box.

5. The new sales order is opened in the L inesLines  view. Make a note of the sales order number.

6. Switch to the HeaderHeader  view.

7. On the Deliver yDeliver y  FastTab, in the Transpor tationTranspor tation section, set the following values:

Shipping carr ier :Shipping carr ier : Flower moving

Carr ier  ser vice:Carr ier  ser vice: Std

8. Switch back to the L inesLines  view.

9. In the Sales order linesSales order lines  section, select Add lineAdd line to add a line to the grid.

10. On the new line, set the following values:

Item number :Item number : A0001

Quantity:Quantity: 1

11. Select the new order line, and then, on the Inventor yInventor y  menu above the grid, select Reser vationReser vation.



View the wave that was created from sales order 2View the wave that was created from sales order 2

Create sales order 3Create sales order 3

View the wave for sales orders 1 and 3View the wave for sales orders 1 and 3

12. On the Reser vationReser vation page, on the Action Pane, select Reser ve lotReser ve lot to reserve the full quantity of the

selected line in the warehouse.

13. Close the Reser vationReser vation page to return to the sales order.

14. On the Action Pane, on the WarehouseWarehouse tab, in the ActionsActions  group, select Release to warehouseRelease to warehouse.

15. You receive an informational message that shows the shipment and wave for this order. Make a note of

the wave ID number and the shipment ID numbers. Notice that the wave ID differs from the wave ID of

the first sales order.

1. Go to Warehouse management > Outbound waves > Shipment waves > All wavesWarehouse management > Outbound waves > Shipment waves > All waves .

2. Select the wave ID that was created from the second sales order.

3. Select the wave ID link to open the wave details page.

4. Notice that the shipment has been added to the Wave linesWave lines  FastTab.

A new wave was created for this shipment, because it uses a different carrier service than the first sales order.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. Select NewNew  to create a sales order.

3. In the Create sales orderCreate sales order  dialog box, set the following values:

On the CustomerCustomer  FastTab, set the Customer accountCustomer account field to US-006.

On the GeneralGeneral  FastTab, set the WarehouseWarehouse field to 62.

4. Select OKOK to create the sales order and close the Create sales orderCreate sales order  dialog box.

5. The new sales order is opened in the L inesLines  view. Make a note of the sales order number.

6. Switch to the HeaderHeader  view.

7. On the Deliver yDeliver y  FastTab, in the Transpor tationTranspor tation section, set the following values:

Shipping carr ier :Shipping carr ier : Air Cargo

Carr ier  ser vice:Carr ier  ser vice: Air

8. Switch back to the L inesLines  view.

9. In the Sales order linesSales order lines  section, select Add lineAdd line to add a line to the grid.

10. On the new line, set the following values:

Item number :Item number : A0001

Quantity:Quantity: 1

11. Select the new order line, and then, on the Inventor yInventor y  menu above the grid, select Reser vationReser vation.

12. On the Reser vationReser vation page, on the Action Pane, select Reser ve lotReser ve lot to reserve the full quantity of the

selected line in the warehouse.

13. Close the Reser vationReser vation page to return to the sales order.

14. On the Action Pane, on the WarehouseWarehouse tab, in the ActionsActions  group, select Release to warehouseRelease to warehouse.

15. You receive an informational message that shows the shipment and wave for this order. Make a note of

the wave ID number and the shipment ID numbers. The shipment has been assigned to the existing wave

from the first sales order.



NOTENOTE

1. Go to Warehouse management > Outbound waves > Shipment waves > All wavesWarehouse management > Outbound waves > Shipment waves > All waves .

2. Select the wave ID that was created from the third sales order.

3. Select the wave ID link to open the wave details page.

4. Notice that the shipment has been added to the Wave linesWave lines  FastTab, together with the shipment for the first

sales order.

Can you tell us about your documentation language preferences? Take a short survey.
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IMPORTANTIMPORTANT

Scenario 1: Reprint labels from the web client

This topic explains how to manage labels that are generated by wave processing. (For a detailed description and

configuration instructions, see Configure wave label printing.)

You can reprint wave labels at any time. For example, you might have to print a single label if an existing label

was lost or damaged. Alternatively, a warehouse worker or supervisor might have to reprint a whole roll of

labels if the number and/or composition of a whole series of wave labels has changed (for example, because of

inventory shortage or other reasons). Often, even if only the number of cartons has changed, the whole roll

must be reprinted to keep the total number accurate in the "Carton X of Y" section of each label.

The reprint wave labels feature supports the following functionality:

Reprint labels from both the warehousing app and the rich client.

Void labels and simultaneously reprint them. (The ability to void labels is embedded in short pick scenarios,

for example.)

Clean up the wave label history.

This topic presents a collection of scenarios that show, through examples, how to work with the reprint wave

labels feature.

To work through the scenarios that are presented in this topic, you must first turn on and configure the relevant wave

printing features, as described in Configure wave label printing. Several of the scenarios in this topic also require that you

first work through the scenarios in that topic to generate prerequisite sample data.

You can view and reprint wave labels from the following pages. On the Action Pane of each page, on the

ShipmentsShipments  tab, in the Related informationRelated information group, select Wave labelsWave labels .

All shipments > Shipment details

All loads > Load details

All waves

Wave labels

Wave label history

To reprint a wave label from the web client, follow these steps.

1. Go to Warehouse management > Outbound waves > Shipment waves > All wavesWarehouse management > Outbound waves > Shipment waves > All waves .

2. Select the wave to reprint labels from.

3. On the Action Pane, on the WaveWave tab, in the Pr intPr int group, select Wave labelsWave labels .

4. Follow one or both of the following steps:

To reprint the label, select a printer in the Pr inter namePrinter name field. (Leave this field blank if you just want to

update the wave label details, without reprinting the label.)

To update the label, select the Update wave label detailsUpdate wave label details  check box. (Leave this check box cleared if

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/reprint-and-void-wave-labels.md


Scenario 2: Reprint labels from the warehousing app

Set up the required menu items and menu for the mobile deviceSet up the required menu items and menu for the mobile device

Create new mobile device menu itemsCreate new mobile device menu items

NOTENOTE

you just want to reprint the previous label.)

Every time that a wave label is printed or reprinted, its data is converted through the appropriate wave label

layout, and all placeholders are replaced with actual values. The resulting string is stored as a record in the wave

label history. If the Update wave label detailsUpdate wave label details  check box is cleared, the stored Zebra Programming Language

(ZPL) data is used when a label is reprinted. If the Update wave label detailsUpdate wave label details  check box is selected, a new string

is generated. The existing wave labels are also recalculated, and any excess labels (for example, if the related work

lines have been canceled or modified) are marked as VoidedVoided and aren't reprinted.

5. Select OKOK to confirm your selection.

This scenario typically applies if a label roll has been lost or damaged. It provides an example that shows how to

set up mobile device menu items that will let workers reprint single and multiple labels. It then shows how to

use those new menu items while you're working on a mobile device.

Before workers can reprint labels from a mobile device, you must set up menu items to provide this

functionality and then add those items to the warehousing app menu.

Follow these steps to create a new collection of menu items for reprinting labels from the warehousing app.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. Create a menu item, and set the following values for it:

Menu item name:Menu item name: Reprint single wave label

Title:Title: Reprint single wave label

Mode:Mode: Indirect

Activity code:Activity code: Reprint single wave label

3. Create a second menu item, and set the following values for it:

Menu item name:Menu item name: Reprint labels (Item)

Title:Title: Reprint wave labels (Item)

Mode:Mode: Indirect

Activity code:Activity code: Reprint multiple wave labels

Display work list grouping filter :Display work list grouping filter : Yes

System grouping field:System grouping field: ShipmentID

System grouping label:System grouping label: Shipment ID

Print mode:Pr int mode: Product

4. On the Action Pane, select Field listField list to open a page where you can select the fields that will be shown to

help workers identify the correct label roll.

5. You can show up to seven fields. Use the drop-down lists to select the field that is shown in each available

position. Leave any fields that you don't require blank.

Here is an example:

Display field:Display field: LabelItemId

Display field 2:Display field 2: LabelItemName

Display field 3:Display field 3: InventQty



Set up the mobile device menuSet up the mobile device menu

Use casesUse cases

Use case 2.1: A single wave label is scratched and must be reprinted.Use case 2.1: A single wave label is scratched and must be reprinted.

Display field 4:Display field 4: LabelUnitId

6. Close the page.

7. Create a third menu item, and set the following values for it:

Menu item name:Menu item name: Reprint labels (Enum)

Title:Title: Reprint wave labels (Enum)

Mode:Mode: Indirect*

Activity code:Activity code: Reprint multiple wave labels

Display work list grouping filter :Display work list grouping filter : Yes

System grouping field:System grouping field: ShipmentID

System grouping label:System grouping label: Shipment ID

Print mode:Pr int mode: Enumeration

8. On the Action Pane, select Field listField list, and then use the drop-down lists to select the fields that will be

shown to help workers identify the correct label roll (for example, LabelItemId, LabelItemName,

InventQty, LabelUnitId, and NumberOfLabels).

9. Close the page.

10. Create a fourth menu item, and set the following values for it:

Menu item name:Menu item name: Reprint labels (by last)

Title:Title: Reprint wave labels (by last)

Mode:Mode: Indirect

Activity code:Activity code: Reprint multiple wave labels

Display work list grouping filter :Display work list grouping filter : Yes

System grouping field:System grouping field: ShipmentID

System grouping label:System grouping label: Shipment ID

Print mode:Pr int mode: Last good wave label ID

11. On the Action Pane, select Field listField list, and then use the drop-down lists to select the fields that will be

shown to help workers identify the correct label roll (for example, LabelItemId, LabelItemName,

InventQty, LabelUnitId, and NumberOfLabels).

12. Close the page.

Follow these steps to add your new menu items to the warehousing app menu.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menuWarehouse management > Setup > Mobile device > Mobile device menu.

2. Select an existing OutboundOutbound menu.

3. In the list on the left, find the reprint menu items that you just created, and then use the right arrow button to

add them to the list on the right.

4. Close the page.

The use cases that are provided here give examples that show how to use the various mobile device menu items

that you set up to enable workers to reprint wave labels.

Before you work through these use cases, the following prerequisites must be in place:

Demo data must be installed, and you must select the USMFUSMF legal entity.

Wave label printing must be configured, and some labels must be generated, as described in Configure wave

label printing.



Use case 2.2: Several labels for boxes of the same item were damaged and must be reprinted. Each label has a product bar code,Use case 2.2: Several labels for boxes of the same item were damaged and must be reprinted. Each label has a product bar code,
but no enumeration or SSCC number.but no enumeration or SSCC number.

Use case 2.3: Several labels for boxes weren't printed because of a printer jam. Because the labels have enumeration, you can defineUse case 2.3: Several labels for boxes weren't printed because of a printer jam. Because the labels have enumeration, you can define
the carton range to reprint.the carton range to reprint.

Use case 2.4: Several labels for boxes weren't printed because of a printer jam. The last good label has a wave label ID that isUse case 2.4: Several labels for boxes weren't printed because of a printer jam. The last good label has a wave label ID that is
printed as a bar code.printed as a bar code.

Scenario 3: Short pick and reprint

1. Sign in to the warehousing app as a user who access to warehouse 62. (In the standard demo data, you can

sign in by using the user ID 62 and the password 1.)

2. Go to Outbound > Reprint single wave labelOutbound > Reprint single wave label .

3. Enter or scan the wave label ID.

4. Select the printer to reprint on.

5. Select OKOK to confirm the action.

1. Sign in to the warehousing app as a user who has access to warehouse 62. (In the standard demo data, you

can sign in by using the user ID 62 and the password 1.)

2. Go to Outbound > Reprint labels (Item)Outbound > Reprint labels (Item) .

3. Enter or scan the shipment ID.

4. Select the tile that has the correct label roll to reprint from.

5. Scan the product bar code from an existing label to confirm that the correct line has been selected.

6. Enter the number of labels to reprint.

7. Select the printer to reprint on.

8. Select OKOK to confirm the action.

1. Sign in to the warehousing app as a user who has access to warehouse 62. (In the standard demo data, you

can sign in by using the user ID 62 and the password 1.)

2. Go to Outbound > Reprint labels (Enum)Outbound > Reprint labels (Enum) .

3. Enter or scan the shipment ID.

4. Select the tile that has the correct label roll to reprint from.

5. Enter the first carton to reprint a label for.

6. Enter the last carton to reprint a label for. Alternatively, leave this field blank to reprint labels for all cartons

after the specified first carton.

7. Select the printer to reprint on.

8. Select OKOK to confirm the action.

1. Sign in to the warehousing app as a user who has access to warehouse 62. (In the standard demo data, you

can sign in by using the user ID 62 and the password 1.)

2. Go to Outbound > Reprint labels (by last)Outbound > Reprint labels (by last) .

3. Enter or scan the shipment ID.

4. Select the tile that has the correct label roll to reprint from.

5. Enter or scan the wave label ID of the last good wave label. The app identifies the next label in the sequence

as the first carton that a label will be reprinted for.

6. Enter the last carton to reprint a label for. Alternatively, leave this field blank to reprint labels for all cartons

after the specified first carton.

7. Select the printer to reprint on.

8. Select OKOK to confirm the action.

Before you work through this scenario, the following prerequisites must be in place:

Demo data must be installed, and you must select the USMFUSMF legal entity.

Wave label printing must be configured, and some labels must be generated, as described in Configure wave



Set up work exceptionsSet up work exceptions

Void and reprint after a short pickVoid and reprint after a short pick

NOTENOTE

label printing.

Work exceptions control the behavior of short picking. Follow these steps to set up a work exception.

1. Go to Warehouse management > Setup > Work > Work exceptionsWarehouse management > Setup > Work > Work exceptions .

2. Create a record that has the following settings:

Work exception code:Work exception code: Short pick and print

Exception type:Exception type: Short pick

Suggest wave labels reprint:Suggest wave labels reprint: Yes

1. Sign in to the warehousing app as a user who has access to warehouse 62. (In the standard demo data, you

can sign in by using the user ID 62 and the password 1.)

2. Open a work processing flow for the sales order work that was created when wave labels were originally

printed.

3. Select Shor t pickShor t pick .

4. Select the work exception code that you created for this scenario.

5. If you selected the correct exception, the Void and reprintVoid and reprint check box should be available. Select this box and

confirm. When confirmed, the label roll sequence identified by the Label build IDLabel build ID field is recalculated based

on the changed work line quantity. It's then reprinted on the specified printer.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Prepare your system to support SPS

Turn on the SPS featureTurn on the SPS feature

Deploy and set up rate enginesDeploy and set up rate engines

Download and deploy the demo rate engineDownload and deploy the demo rate engine

Create and deploy functional rate enginesCreate and deploy functional rate engines

The small parcel shipping (SPS) feature enables Microsoft Dynamics 365 Supply Chain Management to interact

directly with shipping carriers by providing a framework for communication through carrier APIs. This

functionality is useful when you're shipping individual sales orders via commercial shipping carriers instead of

using container shipping or less-than-truckload (LTL) shipping.

The SPS feature interacts with your shipping carrier through a dedicated rate engine. Your organization must

develop this rate engine in collaboration with your carrier or carrier hub service. The rate engine enables Supply

Chain Management to submit details about a packed container to your carrier, and then receive a shipping label,

shipping rate, and tracking number back from that carrier.

The shipping rate that is returned is added to the associated sales order as a miscellaneous charge. The shipping

label that is returned can then automatically be printed by using a Zebra Programming Language (ZPL) printer

and applied to the shipment. The carrier will scan this shipping label when it picks up the packages at your

warehouse.

Before you can start to use SPS functionality, you must turn on the SPS feature in Feature management, add

your rate engine, and set up the Transpor tation managementTranspor tation management and Warehouse managementWarehouse management modules to

support it.

Before you can use the SPS feature, it must be turned on in your system. Administrators can use the Feature

management workspace to check the status of the feature and turn it on if it's required. There, the feature is

listed in the following way:

Module:Module: Transportation management

Feature name:Feature name: Small parcel shipping

Supply Chain Management doesn't include any rate engines. You must obtain or create any rate engines that

you require, and then add them to your system. However, Microsoft provides a demo rate engine that you can

use for testing.

Follow these steps to get the demo rate engine.

1. On GitHub, download the dynamic-link library (DLL) for the demo rate engine.

2. On your Supply Chain Management server, save the DLL in the

\AOSSer vice\PackagesLocalDirector y\ApplicationSuite\bin\AOSSer vice\PackagesLocalDirector y\ApplicationSuite\bin folder.

For information about how to create and deploy functional rate engines so that they can be used in a production

or test environment, see the following topics:

Create a new transportation management engine

Set up transportation management engines

For more information about how to create an SPS rate engine, see the following blog post: Small Parcel

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/small-parcel-shipping.md
https://github.com/microsoft/Dynamics-365-FastTrack-Implementation-Assets/tree/master/SCM/SPS
https://docs.microsoft.com/en-us/dynamicsax-2012/appuser-itpro/set-up-transportation-management-engines
https://hub.bhsolutions.com/creating-a-mock-parcel-engine-in-d365?submissionGuid=46a1fccf-80b0-4b70-a6a0-4bf45a8756b5


Set up a rate engine in Supply Chain ManagementSet up a rate engine in Supply Chain Management

Example scenario

Make demo data availableMake demo data available

Set up the scenarioSet up the scenario

Set up carriersSet up carriers

Shipping: How to leverage small parcel shipping functionality in Microsoft Dynamics 365.

After you've created and deployed a rate engine for SPS, follow these steps to set it up.

1. Go to Transpor tation management > Setup > Engines > Rate engineTranspor tation management > Setup > Engines > Rate engine.

2. On the Action Pane, select NewNew  to add a row to the grid.

3. In the new row, set the following fields:

Rating engineRating engine – Enter a unique name for the rate engine. If you're using the demo rate engine, enter

Demo rate engine.

NameName – Enter a short description of the rate engine. If you're using the demo rate engine, enter Demo

rate engine.

Rating metadata IDRating metadata ID – Select the basis that should be used to calculate your rate. For example, your

rate might be calculated based on distance. If you're using the demo rate engine, you can leave this

field blank.

Engine assemblyEngine assembly  – Enter the file name of the DLL package that you deployed. If you're using the

demo rate engine, enter TMSSmallParcelShippingEngine.dll.

Engine classEngine class  – Enter the class name that was established for your rate engine. If you're using the

demo rate engine, enter TMSSmallParcelShippingEngine.SmallParcelShippingRateEngine.

This example scenario shows how to set up and use SPS after you've prepared your system as described earlier

in this topic. This scenario uses the previously mentioned demo rate engine.

To work through this scenario by using the demo records and values that are specified here, you must be on a

system where the standard demo data is installed. Additionally, you must select the USMFUSMF legal entity before

you begin.

For this example scenario, you must have a demo carrier, carrier group, packing policy, and packing profile. The

following subsections explain how to prepare the records that are required for the scenario. In a production

scenario, the setup process typically resembles the process that is described here. However, you will set different

values.

Follow these steps to set up a carrier.

1. Go to Transpor tation management > Setup > Carr iers > Shipping carr iersTranspor tation management > Setup > Carr iers > Shipping carr iers .

2. On the Action Pane, select NewNew  to add a carrier.

3. On the header, set the following values:

Shipping carr ier :Shipping carr ier : Demo Carrier

Name:Name: Demo Carrier

Mode:Mode: Ground

4. On the Over viewOver view  FastTab, set the following values:

Activate shipping carr ier :Activate shipping carr ier : Yes

Activate carr ier  rating:Activate carr ier  rating: Yes

5. On the Ser vicesSer vices  FastTab, select NewNew  to add a service to the grid.



Set up carrier service accountsSet up carrier service accounts

Set up a container packing policySet up a container packing policy

6. Set the following values for the new service:

Carr ier  ser vice:Carr ier  ser vice: Demo carrier service

Name:Name: Demo carrier service

Transpor tation method:Transpor tation method: Ground

Enter arbitrary values for all the other fields, as required. (When you save the new shipping carrier record,

a new mode of delivery will be created, and the Mode of deliver yMode of deliver y  field will be set automatically.)

7. On the Rating profilesRating profiles  FastTab, select NewNew  to add a rating profile to the grid.

8. Set the following values for the new profile:

Rating profile:Rating profile: Demo carrier service

Name:Name: Demo carrier service

Rate engine:Rate engine: Demo rate engine

Enter arbitrary values for all the other fields, as required.

9. On the Action Pane, select SaveSave.

For more information about how to set up carriers, see Set up shipping carriers.

Follow these steps to set up a carrier service account.

NOTENOTE

1. Go to Transpor tation management > Setup > Rating > Carr ier  ser vice accountTranspor tation management > Setup > Rating > Carr ier  ser vice account.

2. On the Action Pane, select NewNew  to add a carrier service account.

3. Set the following values for the new account:

Shipping Carr ier :Shipping Carr ier : Demo Carrier

Carr ier  ser vice:Carr ier  ser vice: Demo carrier service

Carr ier  customer account number :Carr ier  customer account number : The carrier customer account number that is used to verify

and authenticate the connection to the shipping carrier. Your carrier will provide this value. If you're

using the demo service, you can enter an arbitrary value.

S ite:S ite: 6

Warehouse:Warehouse: 62

Often, the Carrier customer account numberCarrier customer account number  value is the only value that is required to authenticate the

connection. However, if your carrier requires additional authentication parameters, your organization should

customize this page to add extra fields as appropriate.

Follow these steps to set up a container packing policy.

1. If you haven't already set up a ZPL printer definition, use the Document Routing Agent application to set it

up. For more information, see Document printing overview and related topics.

2. Go to Warehouse Management > Setup > Containers > Container packing policiesWarehouse Management > Setup > Containers > Container packing policies .

3. On the Action Pane, select NewNew  to add a container packing policy.

4. On the header of the new policy, set the following values:

Container packing policy:Container packing policy: Demo packing policy

Descr iption:Descr iption: A description of the policy
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Create a sales order and process the workCreate a sales order and process the work

5. On the Over viewOver view  FastTab, set the following values:

Warehouse:Warehouse: 62

Default location for final shipment:Default location for final shipment: Baydoor

Weight unit:Weight unit: KG

Container closing policy:Container closing policy: Automatic release

Container release policy:Container release policy: Make available at final shipping location

6. On the Container manifestContainer manifest FastTab, set the following values:

Automatic manifest at container close:Automatic manifest at container close: Yes

Manifest requirements for container :Manifest requirements for container : Transportation management

Print container contents:Pr int container contents: No

7. On the Carr ier  label pr intingCarr ier  label pr inting FastTab, set the following values:

Pr int container shipping label:Pr int container shipping label: Always

Printer name:Pr inter name: The name of the ZPL printer that should print shipping labels

Follow these steps to set up a packing profile.

1. Go to Warehouse Management > Setup > Packing > Packing profilesWarehouse Management > Setup > Packing > Packing profiles .

2. On the Action Pane, select NewNew  to add a packing profile to the grid.

3. Set the following values for the new profile:

Packing profile ID:Packing profile ID: Demo packing profile

Descr iption:Descr iption: A description of the profile

Container packing policy:Container packing policy: Demo packing policy

Container ID mode:Container ID mode: Auto

Container type:Container type: SmallBox

Follow these steps to set up a customer so that it can use the carrier that you created.

1. Go to Accounts receivable > customers > All customersAccounts receivable > customers > All customers .

2. In the grid, find and select customer US-027.

3. On the Action Pane, on the GeneralGeneral  tab, in the Set upSet up group, select Carr ier  customer accountsCarr ier  customer accounts .

4. On the Carr ier  customer accountsCarr ier  customer accounts  page, on the Action Pane, select NewNew  to add an account to the grid.

5. Set the following values for the new account:

Shipping carr ier :Shipping carr ier : Demo Carrier

Carr ier  customer account number :Carr ier  customer account number : 12345 (The value isn't important for this scenario, but it will

be referred to in the next section.)

After you've set up all the sample data as described in the previous section, you're ready to go through the

example scenario.

Follow these steps to create a sales order.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. Select NewNew  to create a sales order.



Pack the shipmentPack the shipment

3. In the Create sales orderCreate sales order  dialog box, set the Customer accountCustomer account field to US-027.

4. Select OKOK to create the sales order and close the dialog box.

5. The new sales order is opened. On the Sales order headerSales order header  FastTab, set the Carr ier  customer accountCarr ier  customer account

numbernumber  field to the value that you selected for this customer earlier (12345).

6. In the Sales order linesSales order lines  section, add a sales line, and set the following values for it:

Item number :Item number : A0002

Quantity:Quantity: 1

S ite:S ite: 6

Warehouse:Warehouse: 62

7. Switch to the HeaderHeader  view.

8. On the Deliver yDeliver y  FastTab, set the following values:

Shipping carr ier :Shipping carr ier : Demo Carrier

Carr ier  ser vice:Carr ier  ser vice: Demo carrier service

9. Switch back to the L inesLines  view. If you're prompted to update the mode of delivery for the sales lines,

select YesYes .

10. In the Sales order linesSales order lines  section, select the order line that you set up earlier, and then select Inventor yInventor y

> Reser vation> Reser vation.

11. On the Reser vationReser vation page, select Reser ve lotReser ve lot to reserve the selected line's full quantity in the

warehouse.

12. Close the Reser vationReser vation page to return to the sales order.

13. On the Action Pane, on the WarehouseWarehouse tab, select Release to warehouseRelease to warehouse.

Work is created to move items from the picking location to the packing station.

14. In the Sales order linesSales order lines  section, select Warehouse > Shipment detailsWarehouse > Shipment details .

15. On the Shipment detailsShipment details  page, make a note of the shipment ID. You will need it when you pack the pack

the shipment at the packing station.

16. Close the Shipment detailsShipment details  page to return to the sales order.

17. Make a note of the sales order number, and then go to Warehouse management > Work > All workWarehouse management > Work > All work .

18. Use the sales order number to find and select the work that was created for the order.

19. On the Action Pane, on the WorkWork tab, select Complete workComplete work .

20. On the Work completionWork completion page, in the User IDUser ID field, select a user ID. Then, on the Action Pane, select

Validate workValidate work .

21. If the work passes validation, select Complete workComplete work on the Action Pane.

The work is marked as completed to simulate the movement of items to the packing station.

Follow these steps to pack the shipment.

1. Go to Warehouse management > Setup > WorkerWarehouse management > Setup > Worker , and make sure that your user account is

associated with a worker account for warehouse management.

2. Go to Warehouse management > Picking and container ization > PackWarehouse management > Picking and container ization > Pack .



3. In the Select packing stationSelect packing station dialog box, set the following values:

S ite:S ite: 6

Warehouse:Warehouse: 62

Location:Location: Pack

Packing profile ID:Packing profile ID: Demo packing profile

4. Select OKOK.

5. The PackPack page appears. In a production scenario, a worker will scan a license plate or shipment ID.

However, for this scenario, open the All shipmentsAll shipments  page, and look up the shipment number for the

shipment that you just created. Then enter this value in the L icense plate or shipmentLicense plate or shipment field on the

PackPack page. Alternatively, enter the shipment ID that you made a note of earlier.

6. On the Action Pane, select New containerNew container .

7. The dialog box that appears shows details about the new container. Leave the default values, and then

select OKOK.

8. On the PackPack page, on the Item packingItem packing FastTab, in the IdentifierIdentifier  field, select A0002 to pack that item.

The item is added to the container.

9. On the Action Pane, select Containers for shipmentContainers for shipment.

The Containers for shipmentContainers for shipment page that appears has a row for the container that you just created.

However, the Container manifest IDContainer manifest ID field in that row is currently blank, because you haven't yet

received the shipping label and tracking number from the carrier.

10. On the Action Pane, select Close containerClose container .

11. In the Close containerClose container  dialog box, set the Gross weightGross weight field to 1 kg, and then select OKOK.

The shipping label should now be printed on the ZPL printer that you selected earlier. It should resemble

the following example.

12. Notice that the Container manifest IDContainer manifest ID and Total freightTotal freight values have been added as received from the

carrier.
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I receive the following error message: "You can't create a load line for
this order line because it contains inventory dimensions that are
invalid..."
Issue descriptionIssue description

Issue resolutionIssue resolution

I receive the following error message: "One of the lines is already on a
load. Unable to release to warehouse."
Issue descriptionIssue description

Issue resolutionIssue resolution

I receive the following error message: "The delivery note correction
can't be processed. The delivery note only contains items that are
subject to warehouse management processes, as these are not
supported by Delivery Note correction."

This topic describes how to fix common issues that you might encounter while you work with load building and

shipments in Microsoft Dynamics 365 Supply Chain Management.

You receive the following error message when you try to release a return sales order to the warehouse:

You can't create a load line for this order line because it contains inventory dimensions that are invalid. You

can't reference inventory dimensions that are located below the location dimension in the reservation

hierarchy. Remove the invalid dimensions from the order line.

Unfortunately, the product doesn't support load processing for a sales return process. Therefore, you can't

release the return sales order to the warehouse.

On sales order transactions, you can't reference inventory dimensions that are located below the LocationLocation

dimension in the reservation hierarchy. The resolution is to remove the invalid dimensions from the order line.

If you manually create loads, or if you set up the process so that loads are already created before sales order line

entry occurs, the assumption is that the subsequent release will be done manually, and that the route and rating

from the load will be used.

In another possible scenario, you're trying to do an automatic release to the warehouse, but the wave process

failed to create work. Therefore, an open shipment or load is still created. This open shipment or load then

blocks subsequent attempts to automatically release the order until you either delete the open shipment or load,

or manually reprocess the wave.

You can release from the sales order page, or automatic release can be done from the release sales order page,

only if no load exists before the release to the warehouse. The load will automatically be created after the wave

is processed.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/troubleshoot-warehouse-loads-shipments.md
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Issue resolutionIssue resolution

How can I create work from outbound loads instead of waves?
Issue descriptionIssue description

Issue resolutionIssue resolution

I can't re-release a partially shipped load.
Issue descriptionIssue description

Issue resolutionIssue resolution

NOTENOTE

After you post a delivery note, you can't cancel it, because the CancelCancel  button is unavailable. You also can't

correct the delivery note. If you try, you receive this error message.

To correct posted packing slips for items that are enabled for advanced warehouse management (WMS), you

must do the posting from the load, not directly from the order.

Here is one way to reproduce this issue.

1. Create an outbound load by using a sales order or transfer order.

2. Release the load to the warehouse.

3. Notice that no picking work has yet been generated.

If work must be generated immediately when the load is released, you must configure the wave template

accordingly. On the wave template, set the following options to Yes:

Automate wave creation

Process wave at release to warehouse

Automate wave release

You can't release a partially shipped load to the warehouse. When you do the release to the warehouse, an

"Operation complete" message appears, but nothing happens, and no work is created for the remaining

quantity. This issue occurs when you use transport load functionality and there is an incomplete reservation.

KB issue 470069 ("Partially shipped loads can be re-waved and re-processed") is fixed in release 10.0.15.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://fix.lcs.dynamics.com/Issue/Details?kb=4574490&bugId=470069&dbType=3&qc=84ce1e09d7032d8b8ef86f5a0c68b86badf3dfaf29686c5ebbe97c53c0957b5f
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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The shipment consolidation process that uses shipment consolidation policies allows for automated shipment

consolidation during automated and manual release to the warehouse. The automated consolidation that was

available before this feature was introduced had hard-coded fields and was based on the ConsolidateConsolidate

shipment at release to warehouseshipment at release to warehouse field that was set for a warehouse.

Shipment consolidation policies are used for the following functionality:

The automated release-to-warehouse batch job

The Release to warehouseRelease to warehouse command in a sales order or transfer order

The dedicated Release to warehouseRelease to warehouse page

The Release to warehouseRelease to warehouse command on the Load planning workbenchLoad planning workbench page

The manual consolidation of shipments on the Consolidate shipmentsConsolidate shipments  and Shipment consolidationShipment consolidation

workbenchworkbench pages

Before shipment consolidation policies were introduced, the consolidation function existed as a setting at the

warehouse level. All orders for all customers from a single warehouse were treated as though they had the

same consolidation requirements. Shipment consolidation policies add support for scenarios where different

organizations have different requirements for shipment consolidation.

Queries are used to identify the shipment consolidation policy that applies, and then an editable set of fields

determines how the load lines are grouped at the shipment level. (This pattern resembles the pattern that wave

templates follow.) In addition, a Consolidate with existing shipmentsConsolidate with existing shipments  option has been added to each policy.

When this option is turned on, the Release to warehouse procedure finds shipments for consolidation by

searching among existing shipments that were created based on the same consolidation policy. In this case, the

system will select an existing shipment or load instead of creating a new one. However, the system will only

consolidate with existing shipments that have a status of Open; shipments that belong to a wave release with a

status of Released or higher won't be considered as targets for consolidation.

When shipment consolidation policies are made available, the Consolidate shipment at release toConsolidate shipment at release to

warehousewarehouse setting that was previously available on the WarehousesWarehouses  setup page is hidden. To help you

transition to the new shipment consolidation feature, a function on the Shipment consolidation policiesShipment consolidation policies

page creates a default policy that automatically includes the old setting for existing warehouses. After that

default policy is created, the Consolidate shipment at release to warehouseConsolidate shipment at release to warehouse setting on the WarehousesWarehouses

setup page will no longer be considered.

You can use the Release to warehouseRelease to warehouse page to manually override the applicable consolidation policy in the

same way that you can override fulfillment policies.

You can use the Release > Release to warehouseRelease > Release to warehouse command on the Load planning workbenchLoad planning workbench page to

build outbound loads that are based on sales order and transfer order lines before you do the release to the

warehouse. These loads use the same consolidation logic that was introduced together with the consolidation of

shipment policies.

You can use the Shipment consolidation workbenchShipment consolidation workbench page to consolidate existing shipments that haven't yet

been confirmed but have already been released to the warehouse. This functionality supports scenarios where

the automated release process, which has its own shipment consolidation, is run multiple times a day, but

potential additional consolidations are manually identified before the shipment to carriers is completed during

the confirmation process. This functionality lets you consolidate outbound shipments that are created from sales

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/about-shipment-consolidation-policies.md


Overview of new functionality

Shipment consolidation policies pageShipment consolidation policies page

order or transfer order lines at any time after the shipments are released to the warehouse but before they are

confirmed.

The Shipment consolidation workbenchShipment consolidation workbench page works like the load building workbench, where you can

assess multiple shipments at the same time and assign a non-consolidated order to a specific shipment. You can

apply shipment consolidation templates to assess proposed consolidations multiple times and confirm them.

Some rules are implemented to prevent unauthorized consolidation and to warn you about possible errors.

This section describes the pages, commands, and features that are changed or added when you turn on and use

the Shipment consolidation policies feature.

Policies are differentiated by work order type. The Sales ordersSales orders  type represents Sales order shipments, and the

Transfer ordersTransfer orders  type represents Transfer issue shipments.

Every shipment consolidation policy has a query that defines when it's applied and a sequence number that

determines the execution order. Consolidation is applied for each unique combination of the selected fields. An

additional parameter that is provided is used for consolidation with existing (open) shipments. The policies are

evaluated and applied every time that a new shipment is created (before wave processing).

If a policy is missing any mandatory fields, or if it includes any prohibited fields, the policy is marked as not valid

in the SelectedSelected section. The lists of mandatory and prohibited fields are hard-coded and can be extended.

The following list shows the mandatory fields. Because shipments are always split based on these fields, you

can't group multiple shipments that have different values for these fields.

For sales orders:

Account number :Account number : WHSShipmentTable.AccountNum

Deliver y recipient:Deliver y recipient: WHSShipmentTable.DeliveryName

Postal address (RecId):Postal address (RecId): WHSShipmentTable.DeliveryPostalAddress

Warehouse:Warehouse: WHSShipmentTable.InventLocationId

For transfer orders:

From warehouse:From warehouse: InventTransferTable.InventLocationIdFrom

To warehouse:To warehouse: InventTransferTable.InventLocationIdTo

The following fields are unavailable for all document types. These fields aren't visible in the user interface (UI),

and they can't be used for consolidation.

Shipment ID:Shipment ID: WHSShipmentTable.ShipmentId

Status:Status: WHSShipmentTable.ShipmentStatus

Shipment consolidation policy:Shipment consolidation policy: WHSShipmentTable.ShipConsolidationPolicyName

Work transaction type:Work transaction type: WHSShipmentTable.WorkTransType

Wave ID:Wave ID: WHSShipmentTable.WaveId

Load ID:Load ID: WHSShipmentTable.LoadId

Shipment ID:Shipment ID: WHSLoadLine.ShipmentId

Load ID:Load ID: WHSLoadLine.LoadId

By default, when you create a policy, the set of mandatory fields is used as the consolidation fields. However, you

can modify the list by using left arrow and right arrow buttons. (The process resembles the process for selecting

methods in wave templates.)

The values that users select for these fields will be used for all newly created shipments, or they will be added to



Release to warehouse pageRelease to warehouse page

Release to warehouse command on the Load planning workbench pageRelease to warehouse command on the Load planning workbench page

Consolidate shipments pageConsolidate shipments page

Shipment consolidation workbench pageShipment consolidation workbench page

Comparison of functionality
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Not applicable Sales or transfer shipments that are selected for
consolidation must have the same consolidation policy as
the shipment that is being created, or they must be assigned
to an open shipment (when the Consolidate withConsolidate with
existing shipmentsexisting shipments option is turned on).

existing shipments during consolidation with those shipments. When two shipments have the same value for a

field that is selected for consolidation of those shipments, the shipments are consolidated. The same principle

applies for all subsequent consolidation fields that are selected. If the values differ, the second shipment is

discarded and will be selected for a new shipment. The automated consolidation process consists of creating all

the unique combinations of values for the shipment consolidation fields and then assigning a shipment to the

relevant combination.

Unselected fields are ignored during the consolidation process. If two shipments have different values for an

unselected field, the field is cleared (that is, it's set to blank). If both shipments have the same value for an

unselected field, the field is filled in.

The list of consolidation fields (that is, fields that will be cleared if they have different values) is hard-coded. The

list contains all fields that are initialized from a sales order or transfer order line when a new shipment is

created. In other words, if a field isn't initialized from a sales order or transfer order line, it's ignored when new

data is added to an existing shipment.

A new field in the lower grid shows the consolidation policy that was applied.

A new button lets you manually select and/or override the consolidation policy.

The logic was adjusted so that it uses applied consolidation policies.

Shipments are now consolidated only within a single load.

The search for similar shipments (that is, candidates for consolidation) was changed so that it uses fields that

are selected in the shipment consolidation policy.

Fields that have different values in different shipments are now set to blank. (Previously, the values from the

selected "base" shipment were used.)

New functionality replicates the process of manual consolidation on a larger scale.

You can now open this page from the Release to warehouseRelease to warehouse menu in the Warehouse managementWarehouse management

module.

The algorithm analyzes existing shipments that haven't yet been shipped. It then proposes consolidation,

based on fields that are selected in the consolidation policies.

The following table summarizes how shipment consolidation works when you don't use shipment consolidation

policies and when you do use them.



The Release to warehouse procedure doesn't search among
existing shipments to find a shipment for consolidation. Only
shipments that are created by a current instance of the
Release to warehouse procedure are used to find a shipment
for consolidation.

If the Consolidate with existing shipmentsConsolidate with existing shipments option is
turned on for a consolidation policy that is currently being
used, the Release to warehouse procedure searches among
existing shipments that were created based on the same
consolidation policy to find a shipment for consolidation.
Therefore, if you have two policies, a shipment that is being
created based on policy 2 will never be consolidated with a
shipment that was created based on policy 1.

Not applicable If a list of consolidation policy fields is empty, or if a policy
can't be found, a new shipment is created for each sales
order or transfer order line.

The following consolidation field defines the unique
combination of values that is used to consolidate shipments
for a transfer line. (All other fields are ignored.)

The following consolidation fields define the unique
combination of values that is used to consolidate shipments
for a transfer line. (All other fields are ignored.)

These fields are the only fields that are available and
initialized when a new shipment is created.

The following consolidation fields define the unique
combination of values that is used to consolidate shipments
for a sales line. (All other fields are ignored.)

The following consolidation fields define the unique
combination of values that is used to consolidate shipments
for a sales line. (All other fields are ignored.)

These fields are the only fields that are available and
initialized when a new shipment is created.
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Order number (OrderNum) Order number (OrderNum)

Delivery recipient (DeliveryName)

Postal address (DeliveryPostalAddress)

ISO country code (CountryRegionISOCode)

Address (Address)

Site (InventSiteId)

Warehouse (InventLocationId)

Shipping carrier (CarrierCode)

Carrier service (CarrierServiceCode)

Mode of delivery (ModeCode)

Carrier group (CarrierGroupCode)

Delivery terms (DlvTermId)

Order number (OrderNum)

Customer reference (CustomerRef)

Customer requisition (CustomerReq)

Delivery terms (DlvTermId)

Order number (OrderNum)

Account number (AccountNum)

Delivery recipient (DeliveryName)

Postal address (DeliveryPostalAddress)

ISO country code (CountryRegionISOCode)

Address (Address)

Site (InventSiteId)

Warehouse (InventLocationId)

Shipping carrier (CarrierCode)

Carrier service (CarrierServiceCode)

Mode of delivery (ModeCode)

Carrier group (CarrierGroupCode)

Broker ID (BrokerCode)

Direction (LoadDirection)

Delivery terms (DlvTermId)

Customer reference (CustomerRef)

Customer requisition (CustomerReq)



Not applicable The following consolidation fields are mandatory for a sales
line and can't be removed:

By default, these fields will be assigned when a new policy is
created. They can't be removed.

The Release of loads to warehouse procedure on the LoadLoad
planning workbenchplanning workbench page uses its own separate code to
create shipments and waves.

Shipment consolidation policies are applied to determine
which fields should be evaluated for consolidation.
Shipments are consolidated only within a single load.

You manually select Consolidate shipmentsConsolidate shipments on the AllAll
shipmentsshipments page and then select a target "base" shipment.
The filter will suggest any existing shipments that have
matching values for several key fields.

You manually select Consolidate shipmentsConsolidate shipments on the AllAll
shipmentsshipments page and then select a target "base" shipment.
The system will suggest other existing shipments by
matching the values of several key fields that are configured
for the relevant shipment consolidation policies.

You can use the Consolidate shipmentsConsolidate shipments command on the
All shipmentsAll shipments page for only a single shipment.

The Shipment consolidation workbenchShipment consolidation workbench page helps you
find a set of shipments that aren't yet in a shipped state.
These shipments are analyzed based on several key fields
that are configured in your shipment consolidation policies.
Any shipments where the values of these fields match are
suggested for consolidation.

Design note:Design note:  The Automatic release of sales orders to
warehouse procedure splits sales lines into groups. Each
group has its own unique ReleaseToWarehouseIdReleaseToWarehouseId value
and is processed separately by the Release to warehouse
procedure. This procedure creates new work regardless of
the work break setup.

Design note:Design note:  The Automatic release of sales orders to
warehouse procedure assigns the same
ReleaseToWarehouseIdReleaseToWarehouseId value to all sales lines that are
being processed. All sales lines are processed by the Release
to warehouse procedure at the same time. To ensure the
earlier behavior, you must configure work break per
shipment ID.
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Additional resources

NOTENOTE

Account number (AccountNum)

Delivery recipient (DeliveryName)

Postal address (DeliveryPostalAddress)

Warehouse (InventLocationId)

You can manually maintain the consolidation by
removing shipments from suggested consolidations
and/or by adding shipments to them. Several types of
errors can occur, but you can override some of them.

Configure shipment consolidation policies
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The survey will take about seven minutes. No personal data is collected (privacy statement).
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Turn on the Shipment consolidation policies feature

IMPORTANTIMPORTANT

Make demo data available

Scenario 1: Configure default shipment consolidation policies

Upgrade an environment where warehouses are already configured for cross-order consolidationUpgrade an environment where warehouses are already configured for cross-order consolidation

The shipment consolidation process that uses shipment consolidation policies allows for automated shipment

consolidation during automated and manual release to the warehouse. After you turn on this feature, you must

configure your initial policies. If no policies are configured, each sales line will generate a separate shipment that

has a single load line.

The scenarios that are presented in this topic show how to set up default and custom shipment consolidation

policies.

In the first scenario that is described in this topic, you will first set up a warehouse so that it uses the earlier shipment

consolidation feature. You will then make shipment consolidation policies available. In this way, you can experience how

the upgrade scenario works. If you plan to use a demo data environment to go through the first scenario, don't turn on

the feature before you do the scenario.

Before you can use the Shipment consolidation policies feature, you must turn it on in your system. Admins can

use the feature management settings to check the status of the feature and turn it on. In the FeatureFeature

managementmanagement workspace, the feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Consolidate shipment

Each scenario in this topic references values and records that are included in the standard demo data that is

provided for Microsoft Dynamics 365 Supply Chain Management. If you want to use the values that are

provided here as you do the exercises, be sure to work in an environment where the demo data is installed, and

set the legal entity to USMFUSMF before you begin.

There are two situations where you must configure the minimum number of default policies after you turn on

the Shipment consolidation policies feature:

You're upgrading an environment that already contains data.

You're setting up a completely new environment.

When you start this procedure, the Shipment consolidation policies feature should be turned off, to simulate an

environment where the basic cross-order consolidation feature was already used. You will then use feature

management to turn on the feature, so that you can learn how to set up shipment consolidation policies after

the upgrade.

Follow these steps to set up default shipment consolidation policies in an environment where warehouses have

already been configured for cross-order consolidation.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/configure-shipment-consolidation-policies.md


Create default policies for a new environmentCreate default policies for a new environment

NOTENOTE

1. Go to Warehouse management > Setup > Warehouse > WarehousesWarehouse management > Setup > Warehouse > Warehouses .

2. In the list, find and open the desired warehouse record (for example, warehouse 24 in the USMFUSMF demo

data).

3. On the Action Pane, select EditEdit.

4. On the WarehouseWarehouse FastTab, set the Consolidate shipment at release to warehouseConsolidate shipment at release to warehouse option to Yes.

5. Repeat steps 2 through 4 for all other warehouses where consolidation is required.

6. Close the page.

7. Use feature management to turn on the Shipment consolidation policies feature. In the FeatureFeature

managementmanagement workspace, the feature is named Consolidate shipment.

8. Go to Warehouse management > Setup > Release to warehouse > Shipment consolidationWarehouse management > Setup > Release to warehouse > Shipment consolidation

policiespolicies . You might have to refresh your browser to see the new Shipment consolidation policiesShipment consolidation policies

menu item after you turn on the feature.

9. On the Action Pane, select Create default setupCreate default setup to create the following policies:

A CrossOrderCrossOrder  policy for the Sales orders policy type (provided that you have at least one warehouse

that is set up to use the earlier consolidation feature)

A DefaultDefault policy for the Sales orders policy type

A DefaultDefault policy for the Transfer issue policy type

A CrossOrderCrossOrder  policy for the Transfer issue policy type (provided you have at least one warehouse

that is set up to use the earlier consolidation feature)

Both CrossOrderCrossOrder  policies consider the same set of fields as the earlier logic, except for the field for the order

number. (That field is used to consolidate lines into shipments, based on factors such as the warehouse,

transportation mode of delivery, and address.)

Both DefaultDefault  policies consider the same set of fields as the earlier logic, including the field for the order

number. (That field is used to consolidate lines into shipments, based on factors such as the order number,

warehouse, transportation mode of delivery, and address.)

10. Select the CrossOrderCrossOrder  policy for the Sales orders policy type, and then, on the Action Pane, select EditEdit

quer yquer y .

11. In the query editor dialog box, notice that warehouses where the Consolidate shipment at release toConsolidate shipment at release to

warehousewarehouse option is set to Yes are listed. Therefore, they are included in the query.

Follow these steps to set up default shipment consolidation policies in a brand-new environment.

1. Use feature management to turn on the Shipment consolidation policies feature, if you haven't already

turned it on. In the Feature managementFeature management workspace, the feature is named Consolidate shipment.

2. Go to Warehouse management > Setup > Release to warehouse > Shipment consolidationWarehouse management > Setup > Release to warehouse > Shipment consolidation

policiespolicies .

3. On the Action Pane, select Create default setupCreate default setup to create the following policies:

A DefaultDefault policy for the Sales orders policy type

A DefaultDefault policy for the Transfer issue policy type



Scenario 2: Configure custom shipment consolidation policies

Turn on the feature and prepare master data for this scenarioTurn on the feature and prepare master data for this scenario

Turn on the feature and create the default policiesTurn on the feature and create the default policies

Create two new product filter codesCreate two new product filter codes

Create a new transportation mode of deliveryCreate a new transportation mode of delivery

NOTENOTE
Both DefaultDefault  policies consider the same set of fields as the earlier logic, including the field for the order number.

(That field is used to consolidate lines into shipments, based on factors such as the order number, warehouse,

transportation mode of delivery, and address.)

This scenario shows how to set up custom shipment consolidation policies. Custom policies can support

complex business requirements where shipment consolidation depends on several conditions. For each example

policy later in this scenario, a short description of the business case is included. These example policies should

be set up in a sequence that ensures a pyramid-like evaluation of the queries. (In other words, the policies that

have the most conditions should be evaluated as having the highest priority.)

Before you can go through the exercises in this scenario, you must turn on the feature and prepare the master

data that is required to do the filtering, as described in the following subsections. (These prerequisites also apply

to the scenarios listed in Example scenarios of how to use shipment consolidation policies.)

Use feature management to turn on the feature, if you haven't already turned it on, and create the default

consolidation polices that are described in scenario 1.

1. Go to Warehouse management > Setup > Product filters > Product filtersWarehouse management > Setup > Product filters > Product filters , and add two product

filters:

Product filter 1:

Filter  code:Filter  code: Flammable

Filter  title:Filter  title: Code 4

Product filter 2:

Filter  code:Filter  code: Explosive

Filter  title:Filter  title: Code 4

2. Go to Product information management > Products > Released productsProduct information management > Products > Released products .

3. Open the product that has item number M9200. (The product that you select must be enabled for

advanced warehouse [WMS] processes, and this product is pre-enabled for WMS processes in the USMFUSMF

demo data.)

4. On the WarehouseWarehouse FastTab, set the Code 4Code 4  field to Flammable.

5. Close the page.

6. Open the product that has item number M9201. (This product is also pre-enabled for WMS processes in

the in the USMFUSMF demo data.)

7. On the WarehouseWarehouse FastTab, set the Code 4Code 4  field to Explosive.

8. Close the page.

1. Go to Transpor tation management > Setup > Carr iers > ModeTranspor tation management > Setup > Carr iers > Mode.

2. Create a transportation mode that will be used in consolidation queries, and name it Airways.



Create an order poolCreate an order pool

Create example policy 1Create example policy 1

NOTENOTE

3. Go to Transpor tation management > Setup > Carr iers > Shipping carr iersTranspor tation management > Setup > Carr iers > Shipping carr iers .

4. Create a carrier that has the following settings:

Shipping carr ier :Shipping carr ier : Airways

Name:Name: Airways

Mode:Mode: Airways

5. On the Ser vicesSer vices  FastTab for the new carrier, add a row that has the following settings:

Carr ier  ser vice:Carr ier  ser vice: Air

Transpor tation method:Transpor tation method: Air

6. On the Action Pane, select SaveSave.

When you save the new carrier, the Mode of deliver yMode of deliver y  field for the new row in the Ser vicesSer vices grid is automatically

set to Airwa-Air. When you use the Airwa-Air mode of delivery for a sales order, the Airways transportation mode

will be used for related shipments.

1. Go to Sales and marketing > Setup > Sales orders > Order poolsSales and marketing > Setup > Sales orders > Order pools .

2. Create an order pool that will be used for the consolidation query. This order pool should have the

following settings:

Pool:Pool: Enter an integer that isn't already used by any other pool.

Name:Name: ShipCons

3. Go to Sales and marketing > Customers > All customersSales and marketing > Customers > All customers .

4. Open the customer that has account number US-003.

5. On the Sales order defaultsSales order defaults  FastTab, set the Sales order poolSales order pool  field to the order pool that you just

created.

6. Close the page, and then repeat the steps 4 and 5 for the customer that has account number US-004.

In this example, you will create a Customer+Mode policy that can be used for the following business case:

The policy will query for a specific customer account (US-001) and a specific mode of delivery (Airwa-Air).

Consolidation with open shipments is turned off.

Consolidation is done per order ID. (In other words, there will be separate shipments per order, warehouse,

and so on.)

Follow these steps to create the shipment consolidation policy for this business case.

1. Go to Warehouse management > Setup > Release to warehouse > Shipment consolidationWarehouse management > Setup > Release to warehouse > Shipment consolidation

policiespolicies .

2. Set the Policy typePolicy type field to Sales orders.

3. On the Action Pane, select NewNew  to create a policy that has the following settings:

Policy name:Policy name: CustomerMode

Policy descr iption:Policy descr iption: Customer account and mode of delivery

4. Leave the Consolidate with open shipmentsConsolidate with open shipments  option set to No.
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5. On the Action Pane, select SaveSave.

6. On the Consolidation fieldsConsolidation fields  FastTab, in the Remaining fieldsRemaining fields  list, select the row where the FieldField

namename field is set to Mode of delivery.

7. Select the AddAdd button  to move the field to the Selected fieldsSelected fields  list.

8. On the Action Pane, select Edit quer yEdit quer y .

9. In the query editor dialog box, on the RangeRange tab, in the grid, find the row where the FieldField field is set to

Customer account, and set the Criter iaCriter ia field for that row to US-001.

10. Select AddAdd to add a row that has the following settings to the grid:

Table:Table: Order lines

Derived table:Derived table: Order lines

Field:Field: Mode of delivery

Criter ia:Cr iter ia: Airwa-Air

11. Select OKOK to close the dialog box.

For this business case, order lines for customer US-001 that use the Airwa-Air mode of delivery won't be consolidated

across orders. This policy is intended to be used first in a sequence, in cases where shipments for all other modes of

delivery are consolidated for this customer.

In this example, you will create a Hazardous goods policy that can be used for the following business case:

The policy will query for a specific filter code (hazardous) and a specific mode of delivery (Airwa-Air).

Consolidation with open shipments is turned on.

Consolidation is done across orders. (In other words, there will be separate shipments per account,

warehouse, and so on, but only within the item group that is specified in the query.)

Follow these steps to create the shipment consolidation policy for this business case.

1. Go to Warehouse management > Setup > Release to warehouse > Shipment consolidationWarehouse management > Setup > Release to warehouse > Shipment consolidation

policiespolicies .

2. Set the Policy typePolicy type field to Sales orders.

3. On the Action Pane, select NewNew  to create a policy that has the following settings:

Policy name:Policy name: Item type

Policy descr iption:Policy descr iption: Consolidate the same type of item across orders

4. Set the Consolidate with open shipmentsConsolidate with open shipments  option to Yes.

5. On the Action Pane, select SaveSave.

6. On the Consolidation fieldsConsolidation fields  FastTab, in the Remaining fieldsRemaining fields  list, select the row where the FieldField

namename field is set to Mode of delivery.

7. Select the AddAdd button  to move the field to the Selected fieldsSelected fields  list.

8. On the Action Pane, select Edit quer yEdit quer y .

9. In the query editor dialog box, on the JoinsJoins  tab, expand and select Tables > Load detailsTables > Load details  in the tree.

10. Select Add table joinAdd table join .
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11. In the grid of relations that appears, find and select the row where the RelationRelation field is set to Warehouse

item number (Item number), and then select SelectSelect.

12. On the RangeRange tab, select AddAdd to add a row that has the following settings to the grid:

Table:Table: Warehouse item number

Derived table:Derived table: Warehouse item number

Field:Field: Code 4

Criter ia:Cr iter ia: Flammable

13. Select OKOK to close the dialog box.

For this business case, all order lines where items have a specific filter code (that is, the filter code where the Code 4Code 4  field

is set to Flammable) will be consolidated with other items of the same type across orders. If there is an open shipment for

the same account, warehouse, and group of items, the new lines will be attached to it.

In this example, you will create a Customers' requirements policy that can be used for the following business

case:

The policy will query for a specific customer account.

Consolidation with open shipments is turned on.

Consolidation is done across orders but is based on customer requisitions. (In other words, multiple orders

will be grouped into shipments, based on the same customer requisition number and warehouse.)

Follow these steps to create the shipment consolidation policy for this business case.

1. Go to Warehouse management > Setup > Release to warehouse > Shipment consolidationWarehouse management > Setup > Release to warehouse > Shipment consolidation

policiespolicies .

2. Set the Policy typePolicy type field to Sales orders.

3. On the Action Pane, select NewNew  to create a policy that has the following settings:

Policy name:Policy name: CustomerOrderNo

Policy descr iption:Policy descr iption: Consolidate lines based on customer PO

4. Set the Consolidate with open shipmentsConsolidate with open shipments  option to Yes.

5. On the Action Pane, select SaveSave.

6. On the Consolidation fieldsConsolidation fields  FastTab, in the Remaining fieldsRemaining fields  list, select the row where the FieldField

namename field is set to Customer requisition.

7. Select the AddAdd button  to move the field to the Selected fieldsSelected fields  list.

8. In the Remaining fieldsRemaining fields  list, select the row where the Field nameField name field is set to Mode of delivery.

9. Select the AddAdd button  to move the field to the Selected fieldsSelected fields  list.

10. On the Action Pane, select Edit quer yEdit quer y .

11. In the query editor dialog box, on the RangeRange tab, find the row where the FieldField field is set to Customer

account, and set the Criter iaCriter ia field for that row to US-001.

12. Select OKOK to close the dialog box.
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Create example policy 4Create example policy 4

For this business case, all order lines where sales orders have the same customer requisition number will be consolidated

into one shipment, regardless of the sales order number. (The customer requisition number is used as the customer's

purchase order [PO] number.) If there is an open shipment for the same account, warehouse, and customer requisition,

the new lines will be attached to it. This policy can be used if the customer sends additional order lines that have the same

PO number several times during a day and wants all the lines to be grouped into one shipment. (In other words, there will

be one bill of lading and one packing slip.)

In this example, you will create a Customers allowing consolidation policy that can be used for the following

business case:

The policy will query for a specific order pool to identify customers who accept consolidated shipments.

Consolidation with open shipments is turned off.

Consolidation is done across orders using the fields selected by default CrossOrder policy (to replicate

the previous Consolidate shipment at release to warehouseConsolidate shipment at release to warehouse check box).

You can override the rule on a sales order by selecting a different order pool.

Follow these steps to create the shipment consolidation policy for this business case.

1. Go to Warehouse management > Setup > Release to warehouse > Shipment consolidationWarehouse management > Setup > Release to warehouse > Shipment consolidation

policiespolicies .

2. Set the Policy typePolicy type field to Sales orders.

3. On the Action Pane, select NewNew  to create a policy that has the following settings:

Policy name:Policy name: Order pool

Policy descr iption:Policy descr iption: Consolidate across orders based on order pool

4. Leave the Consolidate with open shipmentsConsolidate with open shipments  option set to No.

5. On the Action Pane, select SaveSave.

6. On the Consolidation fieldsConsolidation fields  FastTab, in the Remaining fieldsRemaining fields  list, select the row where the FieldField

namename field is set to Mode of delivery.

7. Select the AddAdd button  to move the field to the Selected fieldsSelected fields  list.

8. On the Action Pane, select Edit quer yEdit quer y .

9. In the query editor dialog box, on the RangeRange tab, select AddAdd to add a row that has the following settings

to the grid:

Table:Table: Sales orders

Derived table:Derived table: Sales orders

Field:Field: Pool

Criter ia:Cr iter ia: ShipCons

10. Select OKOK to close the dialog box.
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Set the orderSet the order

For this business case, all order lines where sales orders belong to the same order pool will be consolidated into one

shipment across sales orders for the same account, warehouse, and transportation mode of delivery. Instead of the order

pool, you can use any other field to distinguish a group of customers and use the sales order header by default. You can

use this approach if the customer, not the warehouse, is driving the need for consolidation. (In the earlier consolidation

logic, the warehouse drove the need for consolidation.)

In this example, you will create a Warehouses allowing consolidation policy that can be used for the following

business case:

The policy will query for a specific order pool to identify warehouses that can consolidate shipments.

Consolidation with open shipments is turned off.

Consolidation is done across orders using the fields selected by default CrossOrder policy (to replicate the

previous Consolidate shipment at release to warehouseConsolidate shipment at release to warehouse check box).

Typically, this business case can be addressed by using the default policies that you created in scenario 1.

However, you can also manually create similar policies by following these steps.

1. Go to Warehouse management > Setup > Release to warehouse > Shipment consolidationWarehouse management > Setup > Release to warehouse > Shipment consolidation

policiespolicies .

2. Set the Policy typePolicy type field to Sales orders.

3. On the Action Pane, select NewNew  to create a policy that has the following settings:

Policy name:Policy name: Cross-order

Policy descr iption:Policy descr iption: Cross-order consolidation for specific warehouses

4. Leave the Consolidate with open shipmentsConsolidate with open shipments  option set to No.

5. On the Action Pane, select SaveSave.

6. On the Consolidation fieldsConsolidation fields  FastTab, in the Remaining fieldsRemaining fields  field, select the row where the FieldField

namename field is set to Mode of delivery.

7. Select the AddAdd button  to move the field to the Selected fieldsSelected fields  list.

8. On the Action Pane, select Edit quer yEdit quer y .

9. In the query editor dialog box, on the RangeRange tab, find the row where the FieldField field is set to Warehouse,

and set the Criter iaCriter ia field for that row to 61, 63.

10. Select OKOK to close the dialog box.

Now that you've created all your policies, you must establish the order that they will be applied in. To use a

pyramid-like approach, where the policies that have the most conditions are evaluated as having the highest

priority, follow these steps.

1. Go to Warehouse management > Setup > Release to warehouse > Shipment consolidationWarehouse management > Setup > Release to warehouse > Shipment consolidation

policiespolicies .

2. Set the Policy typePolicy type field to Sales orders.

3. Select each policy that is listed in the left column, and then use the Move upMove up and Move downMove down buttons

on the Action Pane to arrange the policies in the following order :
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a. CustomerMode

b. Item type

c. CustomerOrderNo

d. Order pool

e. Cross-order

f. Default

The following scenarios illustrate how you could use the shipment consolidation policies that you created while

reading this topic. Each scenario walks you through a shipment consolidation process that uses shipment

consolidation policies during automated or manual release to the warehouse:

Scenario 1: Consolidate shipments when they are released to the warehouse by using Automatic release of

sales orders

Scenario 2: Consolidate shipments when the shipment consolidation policy is overridden from the Release to

warehouse page

Scenario 3: Consolidate shipments by using Release to warehouse from the load planning workbench

Scenario 4: Consolidate shipments by using the shipment consolidation workbench

Scenario 5: Consolidate shipments manually by using the Consolidate shipments page

Shipment consolidation policies

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Consolidate shipments when they are released to
the warehouse by using Automatic release of sales
orders
2/18/2021 • 8 minutes to read • Edit Online

Make demo data available

Set up shipment consolidation policies and product filters

Create the sales orders for this scenario

Create order set 1Create order set 1
Sales order 1-1Sales order 1-1

Sales order 1-2Sales order 1-2

This topic presents a scenario where multiple orders are released to the warehouse in the same automated

release-to-warehouse periodic procedure. The orders will automatically be consolidated into shipments, based

on rules that are defined as shipment consolidation policies.

During the scenario, you will create sets of sales orders and release each set to the warehouse. You will then

review the shipments that are created or updated during shipment consolidation, based on the configured

policies.

The scenario in this topic references values and records that are included in the standard demo data that is

provided for Microsoft Dynamics 365 Supply Chain Management. If you want to use the values that are

provided here as you do the exercises, be sure to work in an environment where the demo data is installed, and

set the legal entity to USMFUSMF before you begin.

The scenario that is described here assumes that you've already turned on the feature, done the exercises in

Configure shipment consolidation policies, and created the policies and other records that are described there.

Be sure to do those exercises before you continue with this scenario.

Start by creating a collection of sales orders that you can work with. You must work with a warehouse that is

enabled for advanced warehouse (WMS) processes. Unless a different warehouse is explicitly mentioned, that

same warehouse must be used for each of the following sets of orders.

Go to Accounts receivable > Orders > All sales ordersAccounts receivable > Orders > All sales orders , and create a collection of sales orders that have

the settings that are described in the following subsections.

1. Create a sales order that has the following settings:

Customer account:Customer account: US-001

Mode of deliver y:Mode of deliver y: Airwa-Air

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

1. Create a sales order that has the following settings:

Customer account:Customer account: US-001

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/consolidate-shipments-automatic.md
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Mode of deliver y:Mode of deliver y: Airwa-Air

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

1. Create a sales order that has the following settings:

Customer account:Customer account: US-001

Mode of deliver y:Mode of deliver y: 10

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

3. Add a second order line that has the following settings:

Item number :Item number : A0002 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

Mode of deliver y:Mode of deliver y: Airwa-Air

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-002

2. Add an order line that has the following settings:

Item number :Item number : M9200 (an item where the Code 4Code 4  filter is set to Flammable)

Quantity:Quantity: 1.00

3. Add a second order line that has the following settings:

Item number :Item number : M9201 (an item where the Code 4Code 4  filter is set to Explosive)

Quantity:Quantity: 1.00

Mode of deliver y:Mode of deliver y: Airwa-Air

1. Create a sales order that has the following settings:

Customer account:Customer account: US-002

2. Add an order line that has the following settings:

Item number :Item number : M9200 (an item where the Code 4Code 4  filter is set to Flammable)

Quantity:Quantity: 1.00

3. Add a second order line that has the following settings:

Item number :Item number : M9201 (an item where the Code 4Code 4  filter is set to Explosive)

Quantity:Quantity: 1.00

Mode of deliver y:Mode of deliver y: Airwa-Air

This order is identical to the two orders that you created for order set 2. However, it's listed as its own order set because

you will release it separately later in this scenario.



Create order set 4Create order set 4
Sales order 4-1Sales order 4-1

Create order set 5Create order set 5
Sales orders 5-1 and 5-2Sales orders 5-1 and 5-2

Sales order 5-3Sales order 5-3

Create order set 6Create order set 6
Sales orders 6-1 and 6-2Sales orders 6-1 and 6-2

Sales orders 6-3 and 6-4Sales orders 6-3 and 6-4

Sales orders 6-5 and 6-6Sales orders 6-5 and 6-6

1. Create a sales order that has the following settings:

Customer account:Customer account: US-001

Customer requisition:Customer requisition: 1

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-001

Customer requisition:Customer requisition: 2

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

1. Create a sales order that has the following settings:

Customer account:Customer account: US-001

Customer requisition:Customer requisition: 1

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-003

Customer requisition:Customer requisition: 2

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-004

Customer requisition:Customer requisition: 1

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-007



              

Sales orders 6-7 and 6-8Sales orders 6-7 and 6-8

Automatic release of sales orders to the warehouse

Basic release-to-warehouse procedureBasic release-to-warehouse procedure

Update the wave template that will be used during releaseUpdate the wave template that will be used during release

Release to the warehouseRelease to the warehouse

Review the shipment that is created or updatedReview the shipment that is created or updated

Site:S ite: 6

Warehouse:Warehouse: 61

Pool:Pool: ShipCons

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-007

Site:S ite: 6

Warehouse:Warehouse: 61

Pool:Pool: Leave this field blank.

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

For each set of sales orders that you created earlier, you will complete a procedure for automatic release to the

warehouse. In each case, you will work through the basic release-to-warehouse procedure that is provided here.

For each set of sales orders that you created earlier, you will complete the three procedures that are outlined in

the following subsections.

1. Go to Warehouse management > Setup > Waves > Wave templatesWarehouse management > Setup > Waves > Wave templates .

2. Set the Wave template typeWave template type field to Shipping.

3. Find and select the wave template that is associated with the warehouse that you used in the order sets that

you created for this scenario. For example, if you used warehouse 24, select the 24 Shipping Default24 Shipping Default wave

template. If you used warehouse 61, select the 61 Shipping61 Shipping wave template.

4. On the Action Pane, select EditEdit.

5. Set the Process wave at release to warehouseProcess wave at release to warehouse option to No.

1. Go to Warehouse management > Release to warehouse > Automatic release of sales ordersWarehouse management > Release to warehouse > Automatic release of sales orders .

2. Set the Quantity to releaseQuantity to release field to All.

3. On the Records to includeRecords to include FastTab, select FilterFilter  to open the query dialog box.

4. On the RangeRange tab, select AddAdd to add a row that has the following settings to the grid:

Table:Table: Sales order

Derived table:Derived table: Sales order

Field:Field: Sales order

Criter ia:Cr iter ia: Enter a comma-separated list of the sales order numbers from the desired order set.

5. Select OKOK to save your query.

6. Select OKOK to start the Automatic release to warehouse procedure.



Release sales orders from order set 1Release sales orders from order set 1

Release sales orders from order set 2Release sales orders from order set 2

Release sales orders from order set 3Release sales orders from order set 3

Release sales orders from order set 4Release sales orders from order set 4

Release sales orders from order set 5Release sales orders from order set 5

Release sales orders from order set 6Release sales orders from order set 6

1. Go to Warehouse management > Shipments > All shipmentsWarehouse management > Shipments > All shipments .

2. Find and select the required shipment.

3. If a consolidation policy was used when the shipment was created or updated, you should see it in the

Shipment consolidation policyShipment consolidation policy  field.

Follow the basic release-to-warehouse procedure to release the sales orders from order set 1.

When you've finished, you should see that two shipments were created:

The first shipment contains three lines and was created by using the CustomerMode shipment consolidation

policy.

The second shipment, which doesn't use the Airways transportation mode of delivery, was created by using

the CustomerOrderNo shipment consolidation policy.

Follow the basic release-to-warehouse procedure to release the sales orders from order set 2.

When you've finished, you should see that three shipments were created:

The first shipment contains Flammable items.

Each of the other two shipments contains one line that has the Explosive item.

Follow the basic release-to-warehouse procedure to release the sales orders from order set 3.

When you've finished, you should see that the following actions occurred:

One existing shipment (the shipment that was created when order set 2 was released to the warehouse) was

updated. A line that has the Flammable item was added.

One new shipment was created that contains the Explosive item.

Follow the basic release-to-warehouse procedure to release the sales orders from order set 4.

When you've finished, you should see that one existing shipment (where the Customer requisitionCustomer requisition field is set

to 1) was updated. One new line was added to it.

Follow the basic release-to-warehouse procedure to release the sales orders from order set 5.

When you've finished, you should see that the following actions occurred:

One existing shipment (where the Customer requisitionCustomer requisition field is set to 1) was updated. A line from sales

order 5-3 (where the Customer requisitionCustomer requisition field is set to 1) was added to it.

One new shipment was created, where lines from sales orders 5-1 and 5-2 are grouped into one shipment.

Follow the basic release-to-warehouse procedure to release the sales orders from order set 6.

When you've finished, you should see that four shipments were created:

Lines from two orders for customer US-003 were grouped into one shipment by using the Order pool

shipment consolidation policy.

Lines from two orders for customer US-004 were grouped into one shipment by using the Order pool

shipment consolidation policy.

Lines from sales orders 6-5 and 6-6 for customer US-007 were grouped into one shipment by using the
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Order pool shipment consolidation policy.

Lines from sales orders 6-7 and 6-8 for customer US-007 were grouped into one shipment by using the

CrossOrder shipment consolidation policy.

Shipment consolidation policies
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Create the sales orders for this scenario

Release the sales orders from the Release to warehouse page

This topic presents a scenario where one or more sales lines must be manually released to the warehouse from

the Release to warehouseRelease to warehouse page, and the system-defined shipment consolidation policy must be overridden

before the release. An override of the shipment consolidation policy might be required if, for example, an order

that isn't usually consolidated with open shipments must be consolidated with open shipments.

During the scenario, you will create a set of sales orders and then override the default shipment consolidation

policy before you release the orders to the warehouse.

The scenario in this topic references values and records that are included in the standard demo data that is

provided for Microsoft Dynamics 365 Supply Chain Management. If you want to use the values that are

provided here as you do the exercises, be sure to work in an environment where the demo data is installed, and

set the legal entity to USMFUSMF before you begin.

The scenario that is described here assumes that you've already turned on the feature, done the exercises in

Configure shipment consolidation policies, and created the policies and other records that are described there.

Be sure to do those exercises before you continue with this scenario.

1. Go to Accounts receivable > Orders > All sales ordersAccounts receivable > Orders > All sales orders , and create three identical sales orders that

have the following settings:

Customer account:Customer account: US-002

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

Follow these steps to override the shipment consolidation policy during the release to the warehouse.

1. Go to Warehouse management > Release to warehouse > Release to warehouseWarehouse management > Release to warehouse > Release to warehouse.

2. In the upper pane, select the first sales order that you created for this scenario.

3. Select AddAdd to add the line to the release to the warehouse. Notice that the Default shipment consolidation

policy is applied in the bottom pane.

4. In the bottom pane, select Select new shipment consolidation policySelect new shipment consolidation policy .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/consolidate-shipments-release-to-warehouse-override.md
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5. Select a policy that allows for consolidation with other open shipments of the same policy. For example,

select the CustomerOrderNo policy.

6. Select Release to warehouseRelease to warehouse.

7. Select the second and third sales orders that you created for this scenario.

8. Select AddAdd to add the lines to the release to the warehouse. Notice that the Default policy is applied in the

bottom pane.

9. Select the second line, and then, in the Select new shipment consolidation policySelect new shipment consolidation policy  field, select the

CustomerOrderNo policy.

10. Select Release to warehouseRelease to warehouse for both lines.

Two shipments should have been created:

The first shipment contains two lines and was created by using the CustomerOrderNo shipment

consolidation policy.

The second shipment contains one line and was created by using the Default shipment consolidation policy.

Follow these steps to review the shipments that were created.

1. Go to Warehouse management > Shipments > All shipmentsWarehouse management > Shipments > All shipments .

2. Find and select the required shipment.

3. In the Shipment consolidation policyShipment consolidation policy  field, review the consolidation policy that was used when the

shipment was created.

Shipment consolidation policies

Configure shipment consolidation policies
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Create the sales orders for this scenario

Create order set 1Create order set 1
Sales order 1-1Sales order 1-1

Sales order 1-2Sales order 1-2

This topic presents a scenario where multiple orders are released to the warehouse in the same load and are

then automatically consolidated into shipments.

The scenario in this topic references values and records that are included in the standard demo data that is

provided for Microsoft Dynamics 365 Supply Chain Management. If you want to use the values that are

provided here as you do the exercises, be sure to work in an environment where the demo data is installed, and

set the legal entity to USMFUSMF before you begin.

The scenario that is described here assumes that you've already turned on the feature, done the exercises in

Configure shipment consolidation policies, and created the policies and other records that are described there.

Be sure to do those exercises before you continue with this scenario.

Start by creating a collection of sales orders that you can work with. You must work with a warehouse that is

enabled for advanced warehouse (WMS) processes. Unless a different warehouse is explicitly mentioned, that

same warehouse must be used for each of the following sets of orders.

Go to Accounts receivable > Orders > All sales ordersAccounts receivable > Orders > All sales orders , and create a collection of sales orders that have

the settings that are described in the following subsections.

1. Create a sales order that has the following settings:

Customer account:Customer account: US-001

Mode of deliver y:Mode of deliver y: Airwa-Air

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

1. Create a sales order that has the following settings:

Customer account:Customer account: US-001

Mode of deliver y:Mode of deliver y: Airwa-Air

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/consolidate-shipments-load-planning-workbench.md
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Create order set 2Create order set 2
Sales orders 2-1 and 2-2Sales orders 2-1 and 2-2

Create order set 3Create order set 3
Sales orders 3-1 and 3-2Sales orders 3-1 and 3-2

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

1. Create a sales order that has the following settings:

Customer account:Customer account: US-001

Mode of deliver y:Mode of deliver y: 10

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

4. Add a second order line that has the following settings:

Item number :Item number : A0002 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

Mode of deliver y:Mode of deliver y: Airwa-Air

5. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the

second order line.

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-002

2. Add an order line that has the following settings:

Item number :Item number : M9200 (an item where the Code 4Code 4  filter is set to Flammable)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

4. Add a second order line that has the following settings:

Item number :Item number : M9201 (an item where the Code 4Code 4  filter is set to Explosive)

Quantity:Quantity: 1.00

Mode of deliver y:Mode of deliver y: Airwa-Air

5. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the

second order line.

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-001

Customer requisition:Customer requisition: 1

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order



Sales orders 3-3 and 3-4Sales orders 3-3 and 3-4

Create order set 4Create order set 4
Sales orders 4-1 and 4-2Sales orders 4-1 and 4-2

Sales orders 4-3 and 4-4Sales orders 4-3 and 4-4

Sales orders 4-5 and 4-6Sales orders 4-5 and 4-6

Sales orders 4-7 and 4-8Sales orders 4-7 and 4-8

line.

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-001

Customer requisition:Customer requisition: 2

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-003

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-004

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-007

Site:S ite: 6

Warehouse:Warehouse: 61

Pool:Pool: ShipCons

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-007

Site:S ite: 6



Use the load planning workbench to create loads and release them to
the warehouse

Verify the shipments

Release order set 1 in one loadRelease order set 1 in one load

Release order set 2 in one loadRelease order set 2 in one load

Release order set 3 in one loadRelease order set 3 in one load

Warehouse:Warehouse: 61

Pool:Pool: Leave this field blank.

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

Follow these steps to create a load for each order set that you created for this scenario and then release it to the

warehouse.

1. Go to Warehouse management > Loads > Load planning workbenchWarehouse management > Loads > Load planning workbench.

2. On the Sales linesSales lines  tab, find and select all the sales order lines from one of the order sets that you created

for this scenario.

3. On the Action Pane, on the Supply and demandSupply and demand tab, select Add > To new loadAdd > To new load to add the selected order

lines to a new Load.

4. In the Load template assignmentLoad template assignment dialog box, in the Load template IDLoad template ID field, select a load template, such

as Stnd Load Template.

5. Select OKOK to close the dialog box.

6. In the LoadsLoads  section, find and select the load that you just created.

7. Select Release > Release to warehouseRelease > Release to warehouse to release the selected load to the warehouse.

8. Repeat this procedure for the other three order sets that you created for this scenario.

The following procedure lets you verify the shipments that have been created or updated as a result of shipment

consolidation. Use it to review each order set that you created for this scenario, and then review the subsections

that follow to make sure that you've obtained the expected results.

1. Go to Warehouse management > Shipments > All shipmentsWarehouse management > Shipments > All shipments .

2. Find and select the required shipment.

3. If a consolidation policy was used when the shipment was created or updated, you should see it in the

Shipment consolidation policyShipment consolidation policy  field.

Two shipments should have been created:

The first shipment contains three lines and was created by using the CustomerMode shipment consolidation

policy.

The second shipment, which doesn't use the Airways transportation mode of delivery, was created by using

the CustomerOrderNo shipment consolidation policy.

Three shipments should have been created:

The first shipment contains the Flammable items.

Each of the other two shipments contains one line that has the Explosive item.



Release order set 4 in one loadRelease order set 4 in one load

Additional resources

NOTENOTE

Two shipments should have been created:

The first shipment contains order lines from the sales order where the Customer requisitionCustomer requisition field is set to

1.

The second shipment contains order lines from sales order where the Customer requisitionCustomer requisition field is set to

2.

Four shipments should have been created:

Lines from two orders for customer account US-003 were grouped into one shipment by using the Order

pool shipment consolidation policy.

Lines from two orders for customer account US-004 were grouped into one shipment by using the Order

pool shipment consolidation policy.

Lines from sales orders 4-5 and 4-6 for customer account US-007 were grouped into one shipment by using

the Order pool shipment consolidation policy.

Lines from sales orders 4-7 and 4-8 for customer account US-007 were grouped into one shipment by using

the CrossOrder shipment consolidation policy.

Shipment consolidation policies

Configure shipment consolidation policies

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Consolidate shipments by using the shipment
consolidation workbench
2/18/2021 • 7 minutes to read • Edit Online

Make demo data available

Set up shipment consolidation policies and product filters

Turn on the manual shipment consolidation feature

Create the sales orders for this scenario

Create order set 1Create order set 1
Sales orders 1-1 and 1-2Sales orders 1-1 and 1-2

This topic presents a scenario where multiple orders are released to the warehouse and then consolidated into

shipments later by using the shipment consolidation workbench.

The scenario in this topic references values and records that are included in the standard demo data that is

provided for Microsoft Dynamics 365 Supply Chain Management. If you want to use the values that are

provided here as you do the exercises, be sure to work in an environment where the demo data is installed, and

set the legal entity to USMFUSMF before you begin.

The scenario that is described here assumes that you've already turned on the feature, done the exercises in

Configure shipment consolidation policies, and created the policies and other records that are described there.

Be sure to do those exercises before you continue with this scenario.

Before you can use the Manual shipment consolidation feature, you must turn it on in your system. Admins can

use the feature management settings to check the status of the feature and turn it on. In the FeatureFeature

managementmanagement workspace, the feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Manual shipment consolidation

As was mentioned in Configure shipment consolidation policies, you must also turn on the Consolidate

shipment feature before you can create policies. However, you should already have completed that step.

Start by creating a collection of sales orders that you can work with. You must work with a warehouse that is

enabled for advanced warehouse (WMS) processes. Unless a different warehouse is explicitly mentioned, that

same warehouse must be used for each of the following sets of orders.

Go to Accounts receivable > Orders > All sales ordersAccounts receivable > Orders > All sales orders , and create a collection of sales orders that have

the settings that are described in the following subsections.

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-001

Mode of deliver y:Mode of deliver y: Airwa-Air

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/consolidate-shipments-manual-workbench.md


Sales order 1-3Sales order 1-3

Create order set 2Create order set 2
Sales orders 2-1 and 2-2Sales orders 2-1 and 2-2

Create order set 3Create order set 3
Sales orders 3-1 and 3-2Sales orders 3-1 and 3-2

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

1. Create a sales order that has the following settings:

Customer account:Customer account: US-001

Mode of deliver y:Mode of deliver y: 10

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

4. Add a second order line that has the following settings:

Item number :Item number : A0002 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

Mode of deliver y:Mode of deliver y: Airwa-Air

5. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the

second order line.

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-002

Mode of deliver y:Mode of deliver y: Airwa-Air

2. Add an order line that has the following settings:

Item number :Item number : M9200 (an item where the Code 4Code 4  filter is set to Flammable)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

4. Add a second order line that has the following settings:

Item number :Item number : M9201 (an item where the Code 4Code 4  filter is set to Explosive)

Quantity:Quantity: 1.00

Mode of deliver y:Mode of deliver y: Airwa-Air

5. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the

second order line.

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-001

Customer requisition:Customer requisition: 1

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00



Sales orders 3-3 and 3-4Sales orders 3-3 and 3-4

Create order set 4Create order set 4
Sales orders 4-1 and 4-2Sales orders 4-1 and 4-2

Sales orders 4-3 and 4-4Sales orders 4-3 and 4-4

Sales orders 4-5 and 4-6Sales orders 4-5 and 4-6

Sales orders 4-7 and 4-8Sales orders 4-7 and 4-8

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-001

Customer requisition:Customer requisition: 2

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-003

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-004

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-007

Site:S ite: 6

Warehouse:Warehouse: 61

Pool:Pool: ShipCons

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-007



Release the orders to the warehouse

Consolidate the shipments by using the shipment consolidation
workbench

Verify the shipments

Related shipments for order set 1Related shipments for order set 1

Site:S ite: 6

Warehouse:Warehouse: 61

Pool:Pool: Leave this field blank.

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

Follow these steps to release each sales order that you created for this scenario to the warehouse.

1. Go to Accounts receivable > Orders > All sales ordersAccounts receivable > Orders > All sales orders .

2. Find and select the sales order to release.

3. On the Action Pane, on the WarehouseWarehouse tab, select Actions > Release to warehouseActions > Release to warehouse to release the

selected sales order.

4. Repeat this procedure for every other sales order that you created for this scenario.

1. Go to Warehouse management > Release to warehouse > Shipment consolidationWarehouse management > Release to warehouse > Shipment consolidation

workbenchworkbench.

2. On the Action Pane, select Edit quer yEdit quer y .

3. In the query editor dialog box, on the RangeRange tab, select AddAdd to add a row that has the following settings

to the grid:

Table:Table: Sales orders

Field:Field: Sales order

Criter ia:Cr iter ia: Enter a comma-separated list of the sales order numbers for each order set that you created

for this scenario.

4. Select OKOK to save your query and close the dialog box.

5. On the Action Pane, select Consolidate shipmentsConsolidate shipments .

6. Select all the shipments, and then, on the Action Pane, select ConsolidateConsolidate.

The following procedure lets you verify the shipments that have been created or updated as a result of shipment

consolidation. Use it to review each order set that you created for this scenario, and then review the subsections

that follow to make sure that you've obtained the expected results.

1. Go to Warehouse management > Shipments > All shipmentsWarehouse management > Shipments > All shipments .

2. Find and select the required shipment.

3. If a consolidation policy was used when the shipment was created or updated, you should see it in the

Shipment consolidation policyShipment consolidation policy  field.

Two shipments should have been created:



Related shipments for order set 2Related shipments for order set 2

Related shipments for order set 3Related shipments for order set 3

Related shipments for order set 4Related shipments for order set 4

Additional resources

NOTENOTE

The first shipment contains three lines and was created by using the CustomerMode shipment consolidation

policy.

The second shipment, which doesn't use the Airways transportation mode of delivery, was created by using

the CustomerOrderNo shipment consolidation policy.

Three shipments should have been created:

The first shipment contains Flammable items.

Each of the other two shipments contains one line that has the Explosive item.

Two shipments should have been created:

The first shipment contains order lines from the sales order where the Customer requisitionCustomer requisition field is set to

1.

The second shipment contains order lines from sales order where the Customer requisitionCustomer requisition field is set to

2.

Four shipments should have been created:

Lines from two orders for customer US-003 were grouped into one shipment by using the Order pool

shipment consolidation policy.

Lines from two orders for customer US-004 were grouped into one shipment by using the Order pool

shipment consolidation policy.

Lines from sales orders 4-5 and 4-6 for customer US-007 were grouped into one shipment by using the

Order pool shipment consolidation policy.

Lines from sales orders 4-7 and 4-8 for customer US-007 were grouped into one shipment by using the

CrossOrder shipment consolidation policy.

Shipment consolidation policies

Configure shipment consolidation policies

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Consolidate shipments manually by using the
Consolidate shipments page
2/18/2021 • 3 minutes to read • Edit Online

Make demo data available

Set up shipment consolidation policies and product filters

Create the sales orders for this scenario

Create sales orders 1 and 2Create sales orders 1 and 2

Create sales orders 3 and 4Create sales orders 3 and 4

This topic presents a scenario where multiple orders are released to the warehouse and then consolidated later

by using the Consolidate shipmentsConsolidate shipments  page.

The scenario in this topic references values and records that are included in the standard demo data that is

provided for Microsoft Dynamics 365 Supply Chain Management. If you want to use the values that are

provided here as you do the exercises, be sure to work in an environment where the demo data is installed, and

set the legal entity to USMFUSMF before you begin.

The scenario that is described here assumes that you've already turned on the feature, done the exercises in

Configure shipment consolidation policies, and created the policies and other records that are described there.

Be sure to do those exercises before you continue with this scenario.

Start by creating a collection of sales orders that you can work with. You must work with a warehouse that is

enabled for advanced warehouse (WMS) processes. Unless a different warehouse is explicitly mentioned, that

same warehouse must be used for each of the following sets of orders.

Go to Accounts receivable > Orders > All sales ordersAccounts receivable > Orders > All sales orders , and create a collection of sales orders that have

the settings that are described in the following subsections.

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-007

Pool:Pool: ShipCons

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

1. Create two identical sales orders that have the following settings:

Customer account:Customer account: US-007

Pool:Pool: Leave this field blank.

2. Add an order line that has the following settings:

Item number :Item number : A0001 (an item that no Code 4Code 4  filter is assigned to)

Quantity:Quantity: 1.00

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/consolidate-shipments-manual-form.md


Release the orders to the warehouse

Consolidate shipments

Additional resources

NOTENOTE

3. Select Inventor y > Reser vationInventor y > Reser vation, and then, on the Action Pane, select Reser ve lotReser ve lot to reserve the order

line.

Follow these steps to release each sales order that you created for this scenario to the warehouse.

1. Go to Accounts receivable > Orders > All sales ordersAccounts receivable > Orders > All sales orders .

2. Find and select the sales order to release.

3. On the Action Pane, on the WarehouseWarehouse tab, select Actions > Release to warehouseActions > Release to warehouse to release the

selected sales order.

4. Repeat this procedure for every other sales order that you created for this scenario.

1. Go to Warehouse management > Shipments > All shipmentsWarehouse management > Shipments > All shipments .

2. Find and select a shipment that was created when sales order 1 was released to the warehouse. (Its

Shipment consolidation policyShipment consolidation policy  field should be set to Order pool.)

3. On the Action Pane, on the ShipmentsShipments  tab, select Shipments > Consolidate shipmentsShipments > Consolidate shipments .

4. Verify the shipments that are suggested for consolidation. Only one shipment that has the same policy

should be suggested for consolidation.

5. Close the Shipment consolidationShipment consolidation page.

6. Find and select a shipment that was created when sales order 3 was released to the warehouse. (Its

Shipment consolidation policyShipment consolidation policy  field should be set to Default.)

7. On the Action Pane, on the ShipmentsShipments  tab, select Shipments > Consolidate shipmentsShipments > Consolidate shipments .

8. Verify that no shipments are suggested for consolidation.

9. Select Show filtersShow filters .

10. In the FiltersFilters  pane, remove the Order numberOrder number  filter, and then select ApplyApply .

11. Verify the shipments that are suggested for consolidation. Only one shipment that has the same policy

should be suggested for consolidation.

Shipment consolidation policies

Configure shipment consolidation policies

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Troubleshoot outbound warehouse operations
2/18/2021 • 2 minutes to read • Edit Online

I receive the following error message: "Sales order could not be
released."
Issue descriptionIssue description

Issue resolutionIssue resolution

I receive the following message: "The shipment for load 1% has been
confirmed." However, no lines are posted.
Issue descriptionIssue description

Issue resolutionIssue resolution

I receive the following error message: "Direct delivery is not able to
process for warehouse 1% as it has warehouse management enabled.
Please specify another warehouse that is not enabled for warehouse
management."
Issue descriptionIssue description

Issue resolutionIssue resolution

This topic describes how to fix common issues that you might encounter while you work with outbound

warehouse operations in Microsoft Dynamics 365 Supply Chain Management.

This issue can occur for several reasons. For example, the order is on credit management hold, and no

shipments can be created until a valid postal address is entered for all sales lines that are associated with a sales

order. Alternatively, there is an order hold that must be addressed before the order can be released to the

warehouse. This hold might be order-specific, or it might be on the customer account.

Add or update the address on the sales order and order lines, and then release the order to the warehouse.

Orders can be released to the warehouse only if they have a valid delivery address (per the address format

setup in the Organization administrationOrganization administration module).

Investigate the order hold, and address the issues. Then remove the hold from the order or customer, and

release the order to the warehouse.

A shipment on a load was confirmed, but no further posting occurred.

Shipment confirmation doesn't affect posting. It just updates the shipment and load status. Posting must occur

in a separate process.

An item is added to a sales line for direct delivery from a warehouse that is enabled for warehouse management

(WMS). You receive this error message when the sales line is updated.

Microsoft has evaluated this issue and has determined that it's a feature limitation. Currently, WMS doesn't

support direct delivery. Therefore, to use direct delivery, you must select a non-WMS item and warehouse.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/troubleshoot-warehouse-outbound.md


NOTENOTE
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Work policies
2/18/2021 • 13 minutes to read • Edit Online

NOTENOTE

Activate the features in your system

The Work policies page

The Work order types FastTabThe Work order types FastTab

W O RK O RDER T Y P EW O RK O RDER T Y P E W O RK P RO C ESSW O RK P RO C ESS

Raw material picking All related processes

Co-product and by-product put away All related processes

Finished goods putaway All related processes

Transfer receipt License plate receiving (and putaway)

This topic explains how to set up the system and the warehouse app so that they support work policies. You can

use this functionality to quickly register inventory without creating putaway work when you receive purchase or

transfer orders, or when you complete manufacturing processes. This topic provides general information. For

detailed information that is related to license plate receiving, see License plate receiving via the warehouse app.

A work policy controls whether warehouse work is created when a manufactured item is reported as finished, or

when goods are received by using the warehouse app. You set up each work policy by defining the conditions

where it applies: the work order types and processes, the inventory location, and (optionally) the products. For

example, a purchase order for product A0001 must be received in location RECV in warehouse 24. Later, the

product is consumed in another process at location RECV. In this case, you can set up a work policy to prevent

putaway work from being created when a worker reports product A0001 as received in location RECV.

For a work policy to be active, you must define at least one location for it on the Inventor y locationsInventor y locations FastTab of the

Work policiesWork policies  page.

You can't specify the same location for multiple work policies.

The Print labelPrint label option for mobile device menu items won't print a license plate label unless work was created.

To make all the functionality that is described in this topic available in your system, turn on the following two

features in Feature management:

License plate receiving enhancements

Work policy enhancements for inbound work

To set up work policies, go to Warehouse management > Setup > Work > Work policiesWarehouse management > Setup > Work > Work policies . Then, on each

FastTab, set the fields as described in the following subsections.

On the Work order typesWork order types  FastTab, add all the work order types, and the related work processes, that the work

policy applies to. The following work order types and related work processes are supported for work policies.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/warehouse-work-policies.md


Purchase orders

W O RK O RDER T Y P EW O RK O RDER T Y P E W O RK P RO C ESSW O RK P RO C ESS

The Inventory locations FastTabThe Inventory locations FastTab

The Products FastTabThe Products FastTab

Default and custom "to" locations

NOTENOTE

License plate receiving (and putaway)

Load item receiving (and putaway)

Purchase order line receiving (and putaway)

Purchase order item receiving (and putaway)

To set up a work policy so that it applies to several work processes of the same work order type, add a separate

line for each work process to the grid.

For each line in the grid, set the Work creation methodWork creation method field to one of the following values:

NeverNever  – The work policy will prevent warehouse work from being created for the selected work order type

and related work process.

Cross dockingCross docking – The work policy will create cross-docking work by using the policy that you select in the

Cross docking policy nameCross docking policy name field.

On the Inventor y locationsInventor y locations  FastTab, add all the locations where this work policy should be applied. If no

location is associated with a work policy, the work policy won't be applied to any process.

You can't specify the same location for multiple work policies.

You can use a warehouse location that is assigned to a location profile where the Use license plate trackingUse license plate tracking

option is turned off. In this case, workers will directly register the on-hand inventory.

On the ProductsProducts  tab, set the Product selectionProduct selection field to control which products the policy should apply to:

AllAll  – The policy should apply to all products.

SelectedSelected – The policy should apply only to products that are listed in the grid. Use the toolbar on the

ProductsProducts  FastTab to add products to the grid or remove them from the grid.

To make the functionality that is described in this section available in your system, you must turn on the License plate

receiving enhancements and Work policy enhancements for inbound work features in Feature management.

Previously, the system supported receiving only at the default location that is defined for each warehouse.

However, mobile device menu items that use the following work creation processes now provide the UseUse

default datadefault data option. This option lets you assign a custom "to" location to one or more menu items. (This option

was already available for some other types of menu items.)

License plate receiving (and putaway)

Load item receiving (and putaway)

Purchase order line receiving (and putaway)

Purchase order item receiving (and putaway)

The To locationTo location setting for a menu item overrides the default receiving location for the warehouse, for all

orders that are processed by using that menu item.

To set up a mobile device menu item to support receiving at a custom location, follow these steps.
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Example scenario: Warehouse receiving

PrerequisitesPrerequisites

Set up a work policySet up a work policy

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. Select or create a menu item that uses one of the work creation processes that are listed earlier in this

section.

3. On the GeneralGeneral  FastTab, set the Use default dataUse default data option to YesYes .

4. On the Action Pane, select Default dataDefault data.

5. On the Default dataDefault data page, set the following values:

Default data field:Default data field: Set this field to To location.

Warehouse:Warehouse: Select the destination warehouse to use with this menu item.

Location:Location: This field lists all the location IDs that are available for the selected warehouse. However,

the setting of this field doesn't actually have any effect. Therefore, you can leave it blank. Nevertheless,

you can use the list to confirm the ID that you must enter in the Hardcoded valueHardcoded value field.

Hardcoded value:Hardcoded value: Enter the location ID for the receiving location that applies to this menu item.

A work policy can be applied only if all the receiving locations are listed in the relevant work policy setup. This requirement

applies regardless of whether you're using the default warehouse receiving location or a custom "to" location.

All products that are received by the Purchase order item receiving (and putaway) process must be registered in

location FL-001, and they must be available in warehouse 24. However, work should not be created. Products

that are received by any other process (that is, by using other mobile device menu items) should be registered at

the default warehouse receiving location (RECV), and work should be created as usual. (This scenario doesn't

show the default receiving setup.)

This scenario requires the following elements:

A work policy for the Purchase order item receiving (and putaway) process in location FL-001, for all

products

A mobile device menu item that has default data, and that sets the To locationTo location field to FL-001

To make the functionality that is described in this scenario available in your system, you must turn on the

License plate receiving enhancements and Work policy enhancements for inbound work features in Feature

management.

This scenario uses the standard demo data. Therefore, if you want to work through it by using the values that

are provided here, you must work on a system where demo data is installed. Additionally, you must select the

USMFUSMF legal entity.

1. Go to Warehouse management > Setup > Work > Work policiesWarehouse management > Setup > Work > Work policies .

2. Select NewNew .

3. In the Work policy nameWork policy name field, enter No purchase item putaway work.

4. Select SaveSave.

5. On the Work order typesWork order types  FastTab, select AddAdd to add a row to the grid, and then set the following values

for the new row:



Set up a mobile device menu item to change the receiving locationSet up a mobile device menu item to change the receiving location

Receive a purchase order without creating workReceive a purchase order without creating work

Create a purchase orderCreate a purchase order

Work order type:Work order type: Purchase orders

Work process:Work process: Purchase order item receiving (and putaway)

Work creation method:Work creation method: Never

Cross docking policy name:Cross docking policy name: Leave this field blank.

6. On the Inventor y locationsInventor y locations  FastTab, select AddAdd to add a row to the grid, and then set the following

values for the new row:

Warehouse:Warehouse: 24

Location:Location: FL-001

7. On the ProductsProducts  FastTab, set the Product selectionProduct selection field to All.

8. Select SaveSave.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. In the left pane, select the existing Purchase receivePurchase receive menu item.

3. On the GeneralGeneral  FastTab, set the Use default dataUse default data option to Yes.

4. Select SaveSave.

5. On the Action Pane, select Default dataDefault data.

6. On the Default dataDefault data page, on the Action Pane, select NewNew  to add a row to the grid, and then set the

following values for the new row:

Default data field:Default data field: To location

Warehouse:Warehouse: 24

Location:Location: Leave this field blank.

Hardcoded value:Hardcoded value: FL-001

7. Select SaveSave.

The example in this section shows how to receive a purchase order item, but without creating work, at a location

that differs from the default receiving location that is set up for the warehouse. This example uses the work

policy and mobile device item that you created earlier in this scenario.

1. Go to Procurement and sourcing > Purchase orders > All purchase ordersProcurement and sourcing > Purchase orders > All purchase orders .

2. Select NewNew .

3. In the Create purchase orderCreate purchase order  dialog box, set the following values:

Vendor account:Vendor account: US-101

Site:S ite: 2

Warehouse:Warehouse: 24

4. Select OKOK to close the dialog box and open the new purchase order.

5. On the Purchase order linesPurchase order lines  FastTab, set the following values for the empty row:

Item number :Item number : A0001

Quantity:Quantity: 1

6. Select SaveSave.

7. Make a note of the purchase order number.



Receive a purchase orderReceive a purchase order

Example scenario: Manufacturing

Example scenario: Report as finished to a location that isn't license

1. On the mobile device, sign in to warehouse 24 by using 24 as the user ID and 1 as the password.

2. Select InboundInbound.

3. Select Purchase receivePurchase receive. The LocationLocation field should be set to FL-001.

4. Enter the purchase order number for the purchase order that you created in the previous procedure.

5. In the Item numberItem number  field, enter A0001.

6. Select OKOK.

7. In the QuantityQuantity  field, enter 1.

8. Select OKOK.

The purchase order is now received, but no work is associated with it. The on-hand inventory has been updated,

and a quantity of 1 of item A0001 is now available at location FL-001.

In the following example, there are two production orders, PRD-001 and PRD-002. Production order PRD-001

has an operation that is named Assembly, where product SC1 is being reported as finished to location 001.

Production order PRD-002 has an operation that is named Painting and consumes product SC1 from location

001. Production order PRD-002 also consumes raw material RM1 from location 001. Raw material RM1 is

stored in warehouse location BULK-001 and will be picked to location 001 by warehouse work for raw material

picking. The picking work is generated when production PRD-002 is released.

When you're planning to configure a warehouse work policy for this scenario, you should consider the following

points:

Warehouse work for putaway of finished goods isn't required when you report product SC1 as finished from

production order PRD-001 to location 001. The reason is that the Painting operation for production order

PRD-002 consumes product SC1 at the same location.

Warehouse work for raw material picking is required to move raw material RM1 from warehouse location

BULK-001 to location 001.

Here is an example of a work policy that you can set up, based on these considerations:

Work policy name:Work policy name: No putaway work

Work order types:Work order types: Finished goods put away and Co-product and by-product put away

Inventor y locations:Inventor y locations: Warehouse 51 and location 001

Products:Products: SC1

The following example scenario provides step-by-step instructions for setting up the warehouse work policy for

this scenario.

file:///T:/eiye/ac1a/dynamics365/supply-chain/warehousing/media/warehouse-work-policies.png


plate–controlled

Set up a warehouse work policySet up a warehouse work policy

Set up an output locationSet up an output location

This scenario shows an example where a production order is reported as finished to a location that isn't license

plate–controlled.

This scenario uses the standard demo data. Therefore, if you want to work through it by using the values that

are provided here, you must work on a system where demo data is installed. Additionally, you must select the

USMFUSMF legal entity.

Warehouse processes don't always include warehouse work. By defining a work policy, you can prevent the

creation of work for raw material picking and putaway of finished goods for a set of products at specific

locations.

1. Go to Warehouse management > Setup > Work > Work policiesWarehouse management > Setup > Work > Work policies .

2. Select NewNew .

3. In the Work policy nameWork policy name field, enter No putaway work.

4. On the Action Pane, select SaveSave.

5. On the Work order typesWork order types  FastTab, select AddAdd to add a row to the grid, and then set the following values

for the new row:

Work order type:Work order type: Finished goods put away

Work process:Work process: All related work processes

Work creation method:Work creation method: Never

Cross docking policy name:Cross docking policy name: Leave this field blank.

6. Select AddAdd again to add a second row to the grid, and then set the following values for the new row:

Work order type:Work order type: Co-product and by-product put away

Work process:Work process: All related work processes

Work creation method:Work creation method: Never

Cross docking policy name:Cross docking policy name: Leave this field blank.

7. On the Inventor y locationsInventor y locations  FastTab, select AddAdd to add a row to the grid, and then set the following

values for the new row:

Warehouse:Warehouse: 51

Location:Location: 001

8. On the ProductsProducts  FastTab, set the Product selectionProduct selection field to Selected.

9. On the ProductsProducts  FastTab, select AddAdd to add a row to the grid.

10. In the new row, set the Item numberItem number  field to L0101.

11. On the Action Pane, select SaveSave.

1. Go to Organization administration > Resources > Resource groupsOrganization administration > Resources > Resource groups .

2. In the left pane, select resource group 51025102 .

3. On the GeneralGeneral  FastTab, set the following values:

Output warehouse:Output warehouse: 51

Output location:Output location: 001

4. On the Action Pane, select SaveSave.



NOTENOTE

Create a production order and report it as finishedCreate a production order and report it as finished

More information

NOTENOTE

Location 001 isn't a license plate–controlled location. You can set up an output location that isn't license plate–controlled

only if an applicable work policy exists for the location.

1. Go to Production control > Production orders > All production ordersProduction control > Production orders > All production orders .

2. On the Action Pane, select New production orderNew production order .

3. In the Create production orderCreate production order  dialog box, set the Item numberItem number  field to L0101.

4. Select CreateCreate to create the order and close the dialog box.

A new production order is added to the grid on the All production ordersAll production orders  page.

Keep the new production order selected.

5. On the Action Pane, on the Production orderProduction order  tab, in the ProcessProcess  group, select EstimateEstimate.

6. In the EstimateEstimate dialog box, read the estimate, and then select OKOK to close the dialog box.

7. On the Action Pane, on the Production orderProduction order  tab, in the ProcessProcess  group, select Star tStar t.

8. In the Star tStar t dialog box, on the GeneralGeneral  tab, set the Automatic BOM consumptionAutomatic BOM consumption field to Never.

9. Select OKOK to save your setting and close the dialog box.

10. On the Action Pane, on the Production orderProduction order  tab, in the ProcessProcess  group, select Repor t as finishedRepor t as finished.

11. In the Repor t as finishedRepor t as finished dialog box, on the GeneralGeneral  tab, set the Accept errorAccept error  option to Yes.

12. Select OKOK to save your setting and close the dialog box.

13. On the Action Pane, on the WarehouseWarehouse tab, in the GeneralGeneral  group, select Work detailsWork details .

When the production order is reported as finished, no work is generated for putaway. This behavior occurs

because a work policy is defined that prevents work from being generated when product L0101 is reported as

finished to location 001.

For more information about mobile device menu items, see Set up mobile devices for warehouse work.

For more information about license plate receiving and work policies, see License plate receiving via the

warehouse app.

For more information about inbound load management, see Warehouse handling of inbound loads for purchase

orders.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Scenario 1

Scenario 2

Scenario 3

Current limitationsCurrent limitations

Set up permission to move reserved inventory for individual workersSet up permission to move reserved inventory for individual workers

BackportedBackported

Using movement of inventory, you can decide which warehouse workers are allowed to move reserved

inventory. This provides a flexibility in regulated warehouses where you can decide to not allow a worker to

choose a new pick location for pick work that is already created. It also allows a warehouse manager to control

which capabilities some less experienced workers should have.

The flexibility to manage the daily operations of warehouse workers can be useful in scenarios such as these:

A company has a relatively small receiving area, and it’s congested with pallets and boxes awaiting put away. A

large shipment is expected on the current day, so the receiving clerk decides to clear up the receiving area by

moving some of the pallets to a secondary inbound staging area.

An experienced warehouse worker notices an opportunity in a warehouse to consolidate items in one location

instead of having them divided across 3 nearby locations with little quantity on each. The worker wants to

consolidate the quantity by moving items from each of these locations into the same location and onto the same

license plate.

A pallet is awaiting shipment in a staging location, such as STAGE01, which is near BAYDOOR01. However, due to

a change of plans the truck is scheduled to arrive at BAYDOOR04. The shipping clerk is aware of this and needs

to ensure that the truck does not have to wait to be loaded from STAGE01. The shipping clerk decides to move

the items in that shipment from STAGE01 to STAGE04, which is closer to the new destination.

The work reservations that you can move are limited to Sales order, Transfer order issue, Transfer order receipt,

Purchase order, and Replenishment work.

Moving items is restricted to prevent splitting of work lines. This means that if you have a work line for 100 pcs

of item A from location Loc1, you won’t be able to move only 30 pcs of item A from there to another location.

This would lead to a split of the existing work line to 30 and 70, because the locations are now different.

For staging scenarios, where the license plate you move the goods from or the license plate you move the

goods to, are set as a Target LP for a work order, only movement of the entire LP is allowed, so as not to break

up the Target LP. Only the ad hoc movement is currently supported. That means that you will not be able to

move reserved inventory through the movement by template mobile device menu items.

For the worker who should be allowed to move reserved inventory, select the Allow movement of inventor yAllow movement of inventor y

with work associatedwith work associated check box under Warehouse managementWarehouse management > SetupSetup > WorkerWorker .

This feature has also been back-ported to Microsoft Dynamics AX 2012 R3 and will be available as part of CU12.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/move-inventory-associated-work.md
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It can also be downloaded individually through KB number 3192548.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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NOTENOTE

This procedure shows you how to set up a work class. Work classes are used to direct and/or limit the type of

work order lines that a warehouse worker can process on a mobile device. The lines that a worker can process

are determined from the work classes on the mobile device menu items that the warehouse worker has access

to and the work class that's specified on the work lines. Work classes can also be used to validate the put

location for a work order line. You can run this procedure in demo data company USMF or on your own data.

This procedure is intended for the warehouse manager.

1. Go to Warehouse management > Setup > Work > Work classes.

2. Click New.

3. In the Work class ID field, type a value.

4. In the Description field, type a value.

5. In the Work order type field, select an option.

6. Click New.

7. In the Location type field, type a value.

8. Close the page.

If you select a location type, this sets a restriction on where items can be put after they've been picked.

This setting is used when a location directive tries to resolve the location, or if a warehouse worker

manually provides the location for the mobile device menu item.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/tasks/create-work-class.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Defining labor standards

Monitoring and controlling warehouse work

This article describes how you can use the warehouse app to help control and monitor the work that's carried

out by employees in your warehouses.

If you're using the functionality in Warehouse management, all warehouse worker operations are referred to as

work. Work such as picking, moving, and counting on-hand inventory is recorded by using mobile devices.

Before a warehouse worker can perform work, he or she must be associated with a worker in Human resources.

Each WorkerWorker  account can have multiple warehouse work users associated with it. Those work users can work in

different warehouses and can have different levels of access to the various mobile device menus. You can think

of the warehouse work users as multiple logons for the selected worker. Each work user has a default

warehouse, and specific workflows are exposed by the menus items that are available to that work user.

To create a new work user, on the WorkersWorkers  page, on the GeneralGeneral  tab, in the WarehousesWarehouses  section, click

WorkerWorker . You must specify a user ID, a user name, a default warehouse, and a menu name. This menu is loaded

when the user signs in to the Warehouse Mobile Device Portal, and lets you define which menu items the user

has access to.

As part of the setup for each work user, you can also define specific process workflows. For example, you can

use the Is a cycle count super visorIs a cycle count super visor  field to specify whether the user can process adjustments to cycle

counting discrepancies during a counting operation, or whether these adjustments must first be reviewed by

another person.

The Labor standardsLabor standards  page lets you define the calculation methods that the system uses to calculate the

estimated time that a particular type of work should require. This definition can be set on a generic level or on a

specific level. For example, you can define the time that should be required in order to process a sales order pick

per weight for a specific unit definition when a specific picking process is used. At the same time, you can record

the time, based on another calculation method, for the put operation of the on-hand inventory that is picked.

To enable the labor standards that you've defined, you must select the Allow labor standardsAllow labor standards  option for each

warehouse where labor standards will be used.

The All workAll work page lets you monitor and maintain all work that is planned, in progress, and completed. From

this page, you can update various processes, such as warehouse work user assignments and work priority. You

can also drill down into the details that are related to the work header and work lines to gain an understanding

of the expected or completed work processes.

If you enable the Labor standardsLabor standards  option, you can see the calculated estimated time for the work. Then, when

the work is processed, the actual time will also be shown for each work operation. In this way, you can compare

the estimated time calculations to the actual time.

Additionally, you can use the estimated time in the rules for automatically splitting work during work creation. In

this way, you can load balance work, based on the expected time to complete the tasks.

Analysis of the time that is used to process work items can help drive improvements in the warehouse workers’

efficiency. The following reports are available to help with this analysis:

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/manage-warehouse-workers.md
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Labor by userLabor by user  – This report shows worker productivity, based on actual times against expected times.

Labor by work transaction typeLabor by work transaction type – You can use this report to investigate inefficiencies in specific

warehouse processes. For example, you notice that picks for transfer orders are taking longer this week than

in previous weeks. You can then use this information for further investigation.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Configuring the work processing policies

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Work processing policy name The name of the work processing policy.

Work order type The work order type that the policy is applied to.

Operation The operation that is processed by using the policy.

Work processing method The method that is used to process the work line. If the
method is set to ImmediateImmediate, the behavior resembles the
behavior when no work processing policies are used to
process the line. If the method is set to DeferredDeferred, deferred
processing that uses the batch framework is used.

Deferred processing threshold A value of 00  (zero) indicates that there is no threshold. In
this case, deferred processing is used if it can be used. If the
specific threshold calculation is below the threshold, the
Immediate method is used. Otherwise, the Deferred method
is used if it can be used. For sales and transfer-related work,
the threshold is calculated as the number of associated
source load lines that are being processed for the work. For
replenishment work, the threshold is calculated as the
number of work lines that are being replenished by the
work. By setting a threshold of, for example, 55  for sales,
smaller works that have fewer than five initial source load
lines won't use deferred processing, but larger works will use
it. The threshold has an effect only if the work processing
method is set to DeferredDeferred.

Deferred processing batch group The batch group that is used for processing.

This topic describes the functionality that makes deferred processing of put operations for warehouse work

available in Dynamics 365 Supply Chain Management.

The deferred processing functionality lets warehouse workers continue to do other work while the put operation

is processed in the background. Deferred processing is useful when many work lines must be processed and the

worker can let that work be processed asynchronously. It's also useful when the server can have ad-hoc or

unplanned increases in processing time, and the increased processing time might affect the user's productivity.

Background processing is achieved by using the SysOperation framework. For more information, see

SysOperation Framework Overview.

To use deferred processing, you must configure and use a work processing policy.

Policies are configured on the Work processing policiesWork processing policies  page. The following table describes the fields on that

page.

For deferred put-processing, the following work order types are supported: sales order, transfer order issue, and

replenishment.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/deferred-put.md
https://docs.microsoft.com/en-us/dynamicsax-2012/developer/sysoperation-framework-overview


Assigning the work creation policy

Viewing the deferred put processing tasks

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Status The status of the task.

Batch job status The status of the related batch job. If the batch job has been
processed, the batch history contains the log and
information from the batch job.

Impact on closed work dates

Reprocessing a failed task

Canceling failed tasks

Configuring the mobile device menu to skip the deferred processing

The work creation policy can be assigned in the warehouse management parameters. It can also be assigned at

the level of individual warehouses. If the policy is assigned to a warehouse, it's applied only to work that is

created for that warehouse. If no policy is assigned at the warehouse level, the policy from the warehouse

management parameters is applied.

You can view deferred put processing tasks on the Deferred put processing tasksDeferred put processing tasks  page.

By default, the CompletedCompleted tasks are shown.

Here is an explanation of the possible statuses:

AwaitingAwaiting – The related batch job is awaiting processing on the batch server.

FailedFailed – The processing failed. The task can be reprocessed by using the Process deferred putProcess deferred put action, or it

can be canceled by using the Cancel deferred putCancel deferred put action.

CompletedCompleted – The job was completed.

When deferred put processing is used, the closed work date is set as the created date/time of the deferred put

processing tasks. The closed work date is used because it's the best estimate for when the put operation was

completed.

You can reprocess a failed task by selecting it on the page and then selecting Process deferred putProcess deferred put.

Reprocessing corresponds to a situation where the user completes the put-away from the mobile device as if it

was set for immediate processing.

Only failed tasks can be canceled. When you cancel a task, you can assign it to a new user. Alternatively, the task

can remain assigned to the user who processed the work. Cancellation corresponds to a situation where the

work is brought back to the mobile device as if the last pick step was just completed and the work must be put

away. However, the user will be able to determine that the work is "different," because it will have only a put-

away step, and the location will correspond to the location that the first user who processed the work had as a

final put location.

When a task is canceled, the work is no longer blocked by the deferred put processing blocking reason. It can be

reprocessed by using the mobile device.

The task record is deleted when the task canceled.



policy

Restrictions when the deferred put processing isn't applied

Monitoring the deferred processing tasks from the Outbound work
monitoring workspace

Deleting completed tasks

NOTENOTE

You can configure the mobile device menu item so that the deferred processing policy isn't used. The work is

then processed as it is when no deferred processing policy is used. This functionality lets a supervisor use a

specific menu item where deferred put isn't used. To configure it, set the Deferred put processing policyDeferred put processing policy  field

to Overr ide settings and process put synchronouslyOverr ide settings and process put synchronously .

There are several scenarios where deferred put processing isn't applied even though the policy is configured.

Here are some examples:

Manual work completion is used.

The work is completed by using auto-completion.

Audit templates are used.

The Outbound work monitor ingOutbound work monitor ing workspace has two tiles that help you monitor deferred put processing

tasks:

Failed deferred put processing tasksFailed deferred put processing tasks  – This tile shows the number of failed tasks. If there are failed tasks,

the warehouse manager must either reprocess them or cancel them, because they won't be reprocessed

automatically.

Awaiting deferred put processing tasksAwaiting deferred put processing tasks  – This tile shows the number of tasks that have been in the

AwaitingAwaiting status for more than 10 minutes. If the tile shows a number, it might indicate that an issue

occurred during batch processing. You can manually process the AwaitingAwaiting tasks. If the batch job for a task is

processed later, it will just fail, because it has already been processed. There will be no impact.

You can delete deferred put processing tasks that have been completed by selecting them and deleting them on

the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Introduction

Configure cross-docking

This topic describes how to manage the process of cross-docking material that is being reported as finished

from a production line to an outbound transportation dock.

Cross-docking from production to an outbound location is relevant for manufacturers who produce high

volume and ideally want to ship the finished products as soon as they are reported as finished from the

production lines. The purpose is to ship the products to distribution centers that are physically located close to

the customer demand, rather than build up inventory at the manufacturing site.

In case there is no immediate demand for a product, it must be put away to warehouse locations on the

manufacturing site. This process is also known as opportunistic cross-docking, which indicates that if there is a

demand for shipping the product, then this opportunity should be used instead of putting the product away for

internal storage.

The following example shows three variations of a flow that starts at the end of the production line (2).

A product is reported as finished to the production output location (3) and a fork lift driver will pick up the pallet

at this location (3).

If there is a planned activity (6) for transferring the product from manufacturing (1) to a distribution center

(7), then the truck driver will be directed by the system to put the pallet by a bay-door location (4).

If a trailer is already assigned to the bay door, the truck driver will be directed to load the product directly to

the trailer.

If there is no planned activity for transferring the product, the fork lift driver will be directed to put the

product away to a location in the internal warehouse (5).

You configure the cross-docking process in work policieswork policies . A work policy includes a work order type, location,

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/production-control/cross-docking-opportunities.md
file:///T:/eiye/ac1a/dynamics365/supply-chain/production-control/media/scenario1.png


Work order typesWork order types

Inventory locationsInventory locations

ProductsProducts

Cross-docking policy name: Transfer orderCross-docking policy name: Transfer order

Sequence numberSequence number

Cross-docking policyCross-docking policy

Cross-docking demand requires locationCross-docking demand requires location

Scenario 1 – Cross-docking from production to transfer ordersScenario 1 – Cross-docking from production to transfer orders

and product. In the following example, cross-docking is configured for product X and location Y.

Work order type: Finished goods put way

Work creation method: Cross docking

Cross docking policy name: Transfer orders

Warehouse: 51

Location: Y

Item number: X

Currently, cross-docking can be configured for only two work order types:

Finished goods put away

Co-product and by-product put away

In the cross-docking policycross-docking policy , you define which document types are applicable for cross-docking. Currently, the

only document type that is supported is Transfer ordersTransfer orders . The following example shows the configuration of a

cross-docking policy.

Sequence number: 10

Cross docking demand requires location: False

Cross docking strategy: Date and time

Work order type: Transfer issue

The sequence numbersequence number  indicates the priority of the document type. Currently, Transfer issueTransfer issue is the only type

that is supported. Therefore, the sequence number will become relevant only when more work order types are

supported.

The cross-docking policy also sets the policy for the prioritization of transfer order demand. For example, if

multiple transfer orders exist for the same product, the scheduled date and time that are set on the load, and

associated with the transfer order, determine the prioritization between the orders. The scheduled date and time

can be set directly on the load, or they can be set on an appointment scheduleappointment schedule that is associated with the load.

The prioritization is determined by the cross-docking strategy. Currently, there is only one strategy: Date andDate and

timetime.

In the cross-docking policy, you can set up a criterion to require that transfer orders have an assigned location in

order to be eligible for cross-docking. This criterion is set in the Cross docking demand requires locationCross docking demand requires location

field. The location on the appointment schedule that is associated with the load is used as the final location for

the goods that are being cross-docked. The final location for the goods that are being cross-docked is

determined by the location directive for Transfer issueTransfer issue for the PutPut work order type. You might find it useful to

set the Cross docking demand requires locationCross docking demand requires location field in a scenario where the finished goods should be

cross-docked only if a trailer is assigned to a bay door. In this scenario, the goods are moved directly from the

production line into the trailer. When a trailer is assigned to the bay door, a user will assign the location to the

appointment schedule and will therefore make the location applicable for cross-docking. The following sections

walk you through two examples.



Scenario 2 - Cross-docking from production to transfer orders with an appointment scheduleScenario 2 - Cross-docking from production to transfer orders with an appointment schedule

After a product is reported as finished at the production line it is transferred to a bay-door location where it is

loaded to a truck and transferred to a distribution center. Use company USMF.

1. Enable a new number sequence for cross-docking. Go to the Number sequencesNumber sequences  page, and select the

GenerateGenerate button. A wizard will guide you through the process.

2. Create a cross-docking policy. Go to the Cross docking policyCross docking policy  page, and create a new policy that is named

Cross docking to transfer orderCross docking to transfer order . Note that the only work order type that you can select is TransferTransfer

issueissue, and the only cross-docking strategy that is available is Date and timeDate and time.

3. Create a work policy. Go to the Work policiesWork policies  page, and create a new work policy that is named CrossCross

Dock L0101Dock L0101 .

4. Set up loads so that they are created automatically for transfer orders. In the warehouse parameters, set up

loads so that they are created automatically when transfer orders are created. A load is a prerequisite for

making the transfer order eligible for cross-docking.

5. Set up the item load mapping. Go to the Item load mappingItem load mapping page, and set up a standard load template for

the CarAudioCarAudio item group. This mapping will automatically insert the load template on the load when the

transfer order is created.

6. Create a transfer order. Create the transfer order for item number L0101. Quantity = 20.

7. Release the transfer order from the load planning workbench. On the ShipShip tab, select the menu item for the

load planning workbench and on the ReleaseRelease menu of the load line, select Release to warehouseRelease to warehouse. An open

wave line of type Transfer issueTransfer issue now exists for the transfer order.

8. Create a production order. Go to the Production orderProduction order  list page, and create a production order for product

L0101. Quantity = 20. Estimate and start the production order. Note that the Post picking list nowPost picking list now  field

remains set to NoNo.

9. Report as finished from the mobile device. Go to the mobile device portal and select menu item Repor t asRepor t as

finished and put awayfinished and put away . Now report as finished L0101 from the handheld device. Quantity = 10. Note that

the put location is BAYDOORBAYDOOR . This location is found from the Transfer issueTransfer issue location directive for the PutPut

work order type. Also notice that work of the type Transfer issueTransfer issue has been created and completed. Go to the

transfer order work details to verify the work.

10. Now report additional 10 pieces from the mobile device. Note that the put location again is BAYDOORBAYDOOR . Also

notice that a new work of type Transfer issueTransfer issue has been created for the 10 pieces.

11. Now try to start 20 pieces more on the production order and then try to report 20 ea as finished by using

the handheld device. This time, location LP-001LP-001  is suggested as the put location. This location is found from

the location directive for Finished goods put awayFinished goods put away . This location directive is being used, because no

opportunity for cross-docking exists. The transfer order for LP-001 was completely fulfilled by the two cross-

docking activities in step 9 and 10. Notice that work of the type Finished goods put awayFinished goods put away  was created and

processed.

After a product is reported as finished at the production line it is transferred to a bay-door location that

is identified by an appointment schedule for the bay-door locations. Use company USMF.

1. Change the cross-docking policy. Change the cross-docking policy that you created in scenario 1 by selecting

the Cross docking demand requires locationCross docking demand requires location check box.

2. Create a new transfer order.

3. Open the Load planning workbenchLoad planning workbench.

4. From the load planning workbench, go to the LoadsLoads  section, and select Appointment scheduleAppointment schedule on the

Transpor tationTranspor tation menu to create a new appointment schedule. Note that the appointment schedule has a

reference to the transfer order in the Order numberOrder number  field. In the Planned star t date/time at locationPlanned star t date/time at location

field, you can set the date and time for the appointment. This date and time will be used when cross-docking

demand is prioritized during the cross-docking process. The date and time that you set in this field will

update the Scheduled load shipping date and timeScheduled load shipping date and time field on the corresponding load. The location on the

Shipping detailsShipping details  FastTab determines the location that the transfer order is shipped on.



Additional informationAdditional information

NOTENOTE

5. On the Load planning workbenchLoad planning workbench release to the warehouse.

6. Create a production order for item number L0101L0101 , and set the status to Star tedStar ted, with a quantity of 20.

7. Report as finished from the mobile device.

8. Go to the mobile device portal, and select the Repor t as finished and put awayRepor t as finished and put away  menu item.

9. Report item number L0101L0101  as finished from the handheld device. Note that the put location is now

BAYDOOR 2BAYDOOR 2 . This location is found from the appointment schedule instead of the Transfer receiptTransfer receipt location

directive.

The cross docking scenario is supported for batch and serial controlled items, both with the batch and serial

number dimensions defined above and below location in the reservation hierarchy.

Can you tell us about your documentation language preferences? Take a short survey.
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Auto-release shipment for cross-docking
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Prerequisites

P REREQ UISIT EP REREQ UISIT E DESC RIP T IO NDESC RIP T IO N

Item The item must be enabled for warehouse management
processes.

Warehouse The warehouse must be enabled for warehouse
management processes.

Cross-docking templates At least one cross-docking template that uses the AtAt
supply receiptsupply receipt  demand release policy must be set up for a
given warehouse.

Work class A cross-docking work class ID must be created for the
Cross dockingCross docking work order type.

This topic describes a cross-docking strategy that lets you automatically release a demand order to the

warehouse when the production order that supplies the demand quantity is reported as finished. In this way, the

quantity that is required for fulfillment of the demand order is moved directly from the production output

location to the outbound location.

Cross-docking is a warehouse handling flow where the quantity that is required to fulfill an outbound order is

directed to the order's outbound dock or staging area from the location where the inbound order was received.

(The inbound order can be a purchase order, a transfer order, or a production order.) Whereas the Advanced

cross-docking feature supports all supply and demand orders, and it requires that the outbound demand be

released before the cross-dock opportunity is identified, the Auto-release shipment feature has these

characteristics:

It supports only production orders as supply, and only sales orders and transfer orders as demand.

The cross-docking operation can be started even if the demand order wasn't released to the warehouse

before the supply receipt was registered (that is, before the production was reported as finished).

This cross-docking functionality has two advantages:

The warehouse operations can skip the step of putting away quantities of finished goods to the regular

warehouse storage area if those quantities will just be picked up again to fulfill the outbound order. Instead,

the quantities can be moved one time, from the output location to a packing/shipping location. In this way,

the functionality helps minimize the number of times that stock is handled and, ultimately, helps maximize

time and space savings on the warehouse shop floor.

The warehouse operations can postpone the release of sales orders and transfer orders to the warehouse

until the output of finished goods for the associated production order is reported as finished. This advantage

might be especially relevant in make-to-order production environments, where manufacturing lead times

tend to be longer than the lead times in make-to-stock environments.

Note:Note:  Catch-weight-enabled items can't be included in
the cross-docking processes.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/auto-release-shipment-for-cross-docking.md


Work templates Work templates of the Cross dockingCross docking work order type are
required to create cross-docking pick and put work.

Location directives Location directives of the Cross dockingCross docking work order type
are required to guide put work in the locations where sales
order quantities will be packed and shipped.

Marking between a demand order and a production order The warehouse system can trigger automatic release of the
outbound order shipment and create cross-docking work
from the output location at the report-as-finished action
only if sales orders and transfer orders are reserved and
marked against a production order.

P REREQ UISIT EP REREQ UISIT E DESC RIP T IO NDESC RIP T IO N

Example cross-docking flow

Example scenario

Set up cross-docking that uses the auto-release shipment featureSet up cross-docking that uses the auto-release shipment feature
Cross-docking templateCross-docking template

A typical cross-docking flow consists of the following main steps.

1. A sales order taker creates a sales order for a make-to-order product. Typically, the requested quantity

isn't on hand and must first be produced.

2. The sales order taker creates a production order directly from the sales order line. In this way, the sales

order taker reserves and marks the sales order quantity against the production order quantity.

Alternatively, a production planner specifies that the marking must be updated when planned orders are

being firmed.

3. The production order goes through the following steps:

a. A production planner estimates and releases the production order. (Estimation includes raw material

reservation, and the release includes the release to a warehouse.)

b. A warehouse worker starts and completes raw material picking from the storage location to the

production input location, according to the production pick work.

c. A shop floor operator starts the production order.

d. In the last operation, a machine operator uses the mobile device to report the production order as

finished.

4. The system uses the setup to identify the cross-docking event for the two linked orders and then

completes these tasks:

a. Automatically release the associated sales order to a warehouse to create a shipment.

b. Automatically create cross-docking work that has instructions to pick the finished goods from the

output location and move them to the outbound location that the cross-docking location directives

assigned to the sales order.

c. Prompt a machine operator to complete the cross-docking work immediately after the production

order is reported as finished.

5. After the cross-docking work is completed, and quantities are loaded onto the vehicle, an outbound

warehouse planner confirms the sales shipment.

For this scenario, you must have demo data installed, and you must use the USMFUSMF demo data company.



Work classesWork classes

Work templatesWork templates

Location directivesLocation directives

NOTENOTE

1. Go to Warehouse managementWarehouse management > SetupSetup > WorkWork > Cross docking templatesCross docking templates .

2. Select NewNew .

3. In the Sequence numberSequence number  field, enter 11 .

4. In the Cross docking template IDCross docking template ID field, enter a name, such as XDock_RAFXDock_RAF .

5. In the Demand release policyDemand release policy  field, select At supply receiptAt supply receipt.

6. In the WarehouseWarehouse field, enter the number of the warehouse where you want to set up the cross-docking

process. For this example, select 5151 .

As soon as you select At supply receiptAt supply receipt  as the demand release policy for the template, all other fields on the

page become unavailable. Likewise, you can't define any supply sources. This behavior occurs because cross-

docking that uses the auto-release shipment feature supports only production orders as supply sources, and it

requires that a marking exist between sales orders and production orders. If you select Before supply receiptBefore supply receipt  as

the demand release policy, the fields on the PlanningPlanning and Supply sourcesSupply sources tabs are available and can be edited.

1. Go to Warehouse managementWarehouse management > SetupSetup > WorkWork > Work classesWork classes .

2. Select NewNew .

3. In the Work class IDWork class ID field, enter a name, such as CrossDockCrossDock .

4. In the Work order typeWork order type field, select Cross dockingCross docking.

To limit the types of locations where cross-docked finished goods can be put, you can specify one or more valid

location types.

1. Go to Warehouse managementWarehouse management > SetupSetup > WorkWork > Work templatesWork templates .

2. In the Work order typeWork order type field, select Cross dockingCross docking.

3. Select NewNew .

4. In the Sequence numberSequence number  field, enter 11 .

5. In the Work templateWork template field, enter a name, such as CrossDock_51CrossDock_51 .

6. Select SaveSave.

7. In the Work Template DetailsWork Template Details  section, select NewNew .

8. For the new line, in the Work typeWork type field, select PickPick . In the Work class IDWork class ID field, select CrossDockCrossDock .

9. Select NewNew .

10. For the new line, in the Work typeWork type field, select PutPut. In the Work class IDWork class ID field, select CrossDockCrossDock .

A standard put-away process for finished goods requires a PutPut location directive to guide the movement of

picked production quantities to a regular storage space. Likewise, you must set up a cross-docking PutPut location

directive to instruct the work to put the finished quantity in a designated outbound location that services the

shipment of the associated sales order.

For cross-docking, as for regular put-away of finished goods, you don't have to create a location directive for the

pick work action, because the output location is given. Additionally, this output location is expected to be set up

either as the default output location on one of the resource-related records (that is, the resource, resource group

relation, or resource group) or as a default production finished goods location for a warehouse.

1. Go to Warehouse managementWarehouse management > SetupSetup > Location directivesLocation directives .

2. In the Work order typeWork order type field, select Cross dockingCross docking.



Cross-dock finished goods to the outbound locationCross-dock finished goods to the outbound location

3. Select NewNew .

4. In the Sequence numberSequence number  field, enter 11 .

5. In the NameName field, enter a name, such as BaydoorBaydoor .

6. In the Work typeWork type field, select PutPut.

7. In the S iteSite field, select 55 .

8. In the WarehouseWarehouse field, select 5151 .

9. On the L inesLines  FastTab, select NewNew .

10. In the To quantityTo quantity  field, enter the maximum quantity of the range, such as 10000001000000 .

11. Select SaveSave.

12. On the Location Directives ActionsLocation Directives Actions  FastTab, select NewNew .

13. In the NameName field, enter a name, such as BaydoorBaydoor .

14. Select SaveSave.

15. You can use the standard query facility to limit put locations to one or more specific locations. Select EditEdit

quer yquer y , and select 5151  as the criterion for the WarehouseWarehouse field in the LocationsLocations  table.

To cross-dock the quantity of finished goods to the outbound location of the associated sales order, follow these

steps.

NOTENOTE

1. Go to Sales and marketingSales and marketing > Sales ordersSales orders  > All sales ordersAll sales orders .

2. Select NewNew .

3. For the sales order header, select customer account US-001US-001  and a warehouse that is set up for cross-

docking that uses the auto-release shipment feature.

4. Add a line for a finished product, and enter 1010  as the quantity.

5. In the Sales order linesSales order lines  section, select Product and supplyProduct and supply  > Production orderProduction order .

6. In the Create production orderCreate production order  dialog box, review the default values, and then select CreateCreate. A new

production order is created and linked to the sales order (that is, it's reserved and marked).

7. Optional: Change the value of the QuantityQuantity  field so that it's more than the value that is required to fulfill

the sales order. When the production quantity is reported as finished, the system will create cross-

docking work for the marked quantity and put-away work for the remaining quantity, according to the

regular procedure for handling the put-away of finished goods.

As was mentioned earlier, a marking must exist between the sales order and the production order.

Otherwise, the cross-docking won't work. A marking can be created in the multiple ways:

The system can automatically create the marking in the following situations:

The production order is manually created directly from the sales order line (see step 6).

Planned production orders are firmed, and the Update markingUpdate marking field is set to StandardStandard.

The user can manually create the marking by opening the MarkingMarking page from the demand order

line.

A marking can't be manually created for items that are set up to use standard and weighted average as inventory

models.

8. On the Production orderProduction order  page, on the Action Pane, on the Production orderProduction order  tab, in the ProcessProcess

group, select EstimateEstimate, and then select OKOK. The order is estimated, and the raw material quantity is



NOTENOTE

reserved for the production.

9. On the Action Pane, on the Production orderProduction order  tab, in the ProcessProcess  group, select ReleaseRelease, and then select

OKOK. Warehouse pick work is created for the raw materials.

10. Open and review the work. On the Action Pane, on the WarehouseWarehouse tab, in the GeneralGeneral  group, select

Work detailsWork details . Make a note of the work ID.

11. Sign in to the warehouse app to run work in warehouse 51.

12. Go to ProductionProduction > Production pickProduction pick .

13. Enter the work ID to start and complete the raw material picking.

After the work is reported as finished, the quantity of raw materials is available in the production input

location (005005  in USMF demo data), and execution of the production order can start.

14. On the Production orderProduction order  page, on the Action Pane, on the Production orderProduction order  tab, in the ProcessProcess

group, select Star tStar t, and then select OKOK.

15. In the app, go to ProductionProduction > RAF and put awayRAF and put away .

16. In the Prod IDProd ID field, enter the production order number and other mandatory details, and then select OKOK.

Notice that the following events occur :

The release to a warehouse is triggered for the linked sales order.

Based on the release, shipment and cross-docking work is created. This work instructs the warehouse

operator to pick the quantities that are required to fulfill the sales order line and put them in the outbound

location that specified in the cross-docking location directive.

If the production order quantity is more than the quantity that is required by the sales order, regular put-

away work is created. This work instructs the warehouse operator to pick the quantity of finished goods that

remains after cross-docking and move it to regular storage, according to the location directive.
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Planned cross-docking
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NOTENOTE

Turn on the Planned cross docking feature

Setup
Regenerate load posting methodsRegenerate load posting methods

Create a cross-docking templateCreate a cross-docking template

This topic describes advanced planned cross-docking. Cross-docking is a warehouse process where the

inventory quantity that is required for an order is directed straight from receipt or creation to the correct

outbound dock or staging area. All remaining inventory from the inbound source is directed to the correct

storage location through the regular put-away process.

Cross-docking lets workers skip inbound put-away and outbound picking of inventory that is already marked

for an outbound order. Therefore, the number of times that inventory is touched is minimized, where possible.

Additionally, because there is less interaction with the system, time and space savings on the warehouse shop

floor are increased.

Before cross-docking can be run, the user must configure a new cross-docking template, where the supply

source and other sets of requirements for cross-docking are specified. As the outbound order is created, the line

must be marked against an inbound order that contains the same item.

At the time of inbound order receiving, the cross-docking setup automatically identifies the need for cross-

docking and creates the movement work for the required quantity, based on the setup of the location directive.

Inventory transactions are notnot  unregistered when crossing-dock work is canceled, even if the setting for this capability is

turned on in Warehouse management parameters.

Before you can use advanced planned cross-docking, the feature must be turned on in your system. Admins can

use the Feature management workspace to check the status of the feature and turn it on if it's required. There,

the feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Planned cross docking

Planned cross-docking is implemented as a load posting method. After you turn on the feature, you must

regenerate the methods.

1. Go to Warehouse management > Setup > Load posting methodsWarehouse management > Setup > Load posting methods .

2. On the Action Pane, select Regenerate methodsRegenerate methods .

When regeneration is completed, you should see a method that has a Method nameMethod name value of

planCrossDocking.

3. Close the page.

1. Go to Warehouse management > Setup > Work > Cross docking templatesWarehouse management > Setup > Work > Cross docking templates .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/planned-cross-docking.md


2. On the Action Pane, select NewNew  to create a template.

3. In the header, set the following values:

Sequence:Sequence: 1

This field defines the order that templates are evaluated in.

Cross docking template ID:Cross docking template ID: 51

Descr iption:Descr iption: Warehouse 51

Demand release policy:Demand release policy: Before supply receipt

Warehouse:Warehouse: 51

4. The setup on the PlanningPlanning FastTab controls how the template works. Set the following values:

Demand requirements:Demand requirements: None

This field defines the requirements of the demand inventory. If the demand must be linked to the

supply before release, select Marking. If the demand must be order-reserved against the supply

before release, select Order reservation.

Locating type:Locating type: Shipment locations

This field defines whether the cross-docking work should use the staging/load locations from the

shipment, or whether it should use location directives to find its own staging/load locations.

Work template:Work template: Leave this field blank.

This field defines the work template that should be used when cross-docking work is created.

Revalidate on supply receipt:Revalidate on supply receipt: No

This option defines whether the supply should be revalidated during receipt. If this option is set to

Yes, both the maximum time window and the expiration days range are checked.

Validate time window:Validate time window: Yes

This option defines whether the maximum time window should be evaluated when a supply

source is selected. If this option is set to Yes, the fields that are related to the maximum and

minimum time windows become available.

Maximum time window:Maximum time window: 5

This field defines the maximum period that is allowed between supply arrival and demand

departure.

Maximum time window unit:Maximum time window unit: Days

Minimum time window:Minimum time window: 0

This field defines the minimum period that is allowed between supply arrival and demand

departure.

Minimum time window unit:Minimum time window unit: Days

Expiration days range:Expiration days range: 0

First expiry first out (FEFO) criteria: This field defines the maximum number of days between the

expiration date of the first-expiring batch that is currently in the warehouse and the batch that is

being received.



Create a work classCreate a work class

Create a work templateCreate a work template

NOTENOTE

Create location directivesCreate location directives

5. On the Supply sourcesSupply sources  FastTab, you specify the types of supply that are valid for this template. Select

NewNew , and then set the following values:

Sequence number :Sequence number : 1

Supply source:Supply source: Purchase order

1. Go to Warehouse management > Setup > Work > Work classesWarehouse management > Setup > Work > Work classes .

2. On the Action Pane, select NewNew  to create a work class.

3. Set the following values:

Work class ID:Work class ID: CrossDock

Descr iption:Descr iption: Cross Dock

Work order type:Work order type: Cross docking

1. Go to Warehouse management > Setup > Work > Work templatesWarehouse management > Setup > Work > Work templates .

2. Set the Work order typeWork order type field to Cross docking.

3. On the Action Pane, select NewNew  to add a line to the Over viewOver view  tab.

4. On the new line, set the following values:

Sequence number :Sequence number : 1

Work template:Work template: 51 Cross Dock

Work template descr iption:Work template descr iption: 51 Cross Dock

5. Select SaveSave to make the Work Template DetailsWork Template Details  FastTab available.

6. On the Work Template DetailsWork Template Details  FastTab, select NewNew  to add a line to the grid.

7. On the new line, set the following values:

Work type:Work type: Pick

Work class ID:Work class ID: CrossDock

8. Select NewNew  to add another line, and set the following values on it:

Work type:Work type: Put

Work class ID:Work class ID: CrossDock

9. Select SaveSave, and confirm that the ValidValid check box is selected for the 51 Cross Dock template.

The work class IDs for the Pick and Put work types must be the same.

1. Go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives .

2. In the left pane, set the Work order typeWork order type field to Cross docking.

3. On the Action Pane, select NewNew , and set the following values:

Sequence number :Sequence number : 1

Name:Name: 51 Cross Dock Put

Work type:Work type: Put



Create a mobile device menu itemCreate a mobile device menu item

Scenario
Create a purchase orderCreate a purchase order

Site:S ite: 5

Warehouse:Warehouse: 51

4. Select SaveSave to make the L inesLines  FastTab available.

5. On the L inesLines  FastTab, select NewNew  to add a line to the grid.

6. On the new line, set the following values:

From quantity:From quantity: 1

To quantity:To quantity: 1,000,000

7. Select SaveSave to make the Location Directive ActionsLocation Directive Actions  FastTab available.

8. On the Location Directive ActionsLocation Directive Actions  FastTab, select NewNew  to add a line to the grid.

9. On the new line, set the following values:

Name:Name: Baydoor

Fixed location usage:Fixed location usage: Fixed and non-fixed locations

10. Select SaveSave to make the Edit quer yEdit quer y  button on the Location Directive ActionsLocation Directive Actions  toolbar available.

11. Select Edit quer yEdit quer y  to open the query editor.

12. On the RangeRange tab, make sure that the following two lines are configured:

Line 1:

Table:Table: Locations

Derived Table:Derived Table: Locations

Field:Field: Warehouse

Criter ia:Cr iter ia: 51

Line 2:

Table:Table: Locations

Derived Table:Derived Table: Locations

Field:Field: Location

Criter ia:Cr iter ia: Baydoor

13. Select OKOK to close the query editor.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. In the list of menu items in the left pane, select Purchase Put-awayPurchase Put-away .

3. Select EditEdit.

4. On the Work classesWork classes  FastTab, select NewNew  to add a line to the grid.

5. On the new line, set the following values:

Work class ID:Work class ID: CrossDock

Work order type:Work order type: Cross docking

6. Select SaveSave.

Follow these steps to create a purchase order as a source of supply.



Create a sales orderCreate a sales order

Create planned cross-dockingCreate planned cross-docking

Process the cross-docking
Purchase order receiving on the warehousing mobile appPurchase order receiving on the warehousing mobile app

1. Go to Procurement and sourcing > Purchase orders > All purchase ordersProcurement and sourcing > Purchase orders > All purchase orders .

2. On the Action Pane, select NewNew .

3. In the Create purchase orderCreate purchase order  dialog box, set the following values:

Vendor account:Vendor account: 104

Warehouse:Warehouse: 51

4. Select OKOK, and make a note of the order number.

5. A new line is added to the Purchase order linesPurchase order lines  FastTab. On this line, set the following values:

Item number :Item number : A0001

Quantity:Quantity: 5

Follow these steps to create a sales order as a source of demand.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. On the Action Pane, select NewNew .

3. In the Create sales orderCreate sales order  dialog box, set the following values:

Customer account:Customer account: US-002

Warehouse:Warehouse: 51

4. Select OKOK.

5. A new line is added to the Sales order linesSales order lines  FastTab. On this line, set the following values:

Item number :Item number : A0001

Quantity:Quantity: 3

Follow these steps to create the planned cross-docking from the sales order.

1. In the Sales order detailsSales order details  page for the sales order that you just created, on the Action Pane, on the

WarehouseWarehouse tab, in the ActionsActions  group, select Release to warehouseRelease to warehouse.

The release to warehouse action creates a shipment and load line for the sales order line, and tries to

allocate inventory.

You receive an informational message. You also receive the following warning message: "No work was

created for wave XXXX. See the work creation history log for details." This behavior is expected, because

there is no inventory in the warehouse.

2. On the Sales order linesSales order lines  FastTab, on the WarehouseWarehouse menu, select Shipment detailsShipment details .

The Shipment detailsShipment details  page appears and shows the shipment that was created for the sales order.

3. On the Load linesLoad lines  FastTab, notice that the Planned cross docking quantityPlanned cross docking quantity  field is set to 3. Because

no inventory was available in the warehouse, but a valid supply source will arrive within the time window

that is defined in the cross-docking template, the cross-docking quantity was created.

4. On the Load linesLoad lines  FastTab, select Planned cross dockingPlanned cross docking to view the details of the cross-docking that

was created.



Put-away to cross-docking and bulkPut-away to cross-docking and bulk

The system will receive the quantity of 5 from the purchase order into the receiving location and create two

pieces of work.

The first work ID that is created has a Work order typeWork order type value of Cross docking and is linked to the sales order.

It has a quantity of 3 and is directed to the final shipping location so that it can be shipped out immediately.

The second work ID that is created has a Work order typeWork order type value of Purchase orders and is linked to the

purchase order. It has the remaining quantity of 2 that wasn't cross-docked and is directed to put-away to

storage.

1. Sign in to the mobile device as a user in warehouse 51.

2. Go to Inbound > Purchase ReceiveInbound > Purchase Receive.

3. In the PONumPONum field, enter your purchase order number.

4. In the QtyQty  field, enter 5.

5. Select OKOK.

6. On the next page, set the ItemItem field to A0001.

7. Select OKOK.

8. On the next page, confirm the PONumPONum, ItemItem, and QtyQty  values by selecting OKOK.

You receive a "Work Completed" message.

9. Select CancelCancel  to exit.

Currently, both work IDs have the same target license plate. To complete the next steps, you must get the work

ID and the target license plate ID. You can get this information from the work details for the purchase order line

and the sales order line. Alternately, you can go to Warehouse management > Work > Work detailsWarehouse management > Work > Work details  and

filter for work where the WarehouseWarehouse value is 51.

1. On the mobile device, go to Inbound > Purchase put-awayInbound > Purchase put-away , and enter the target license plate from the

work.

2. In the IDID field, enter the target license plate ID from the work details.

The cross-docking pick page shows the picking location (RECV), target license plate (license plate), item

(A0001), and quantity (3).

3. Select OKOK.

4. In the Target LPTarget LP field, enter a target license plate for the license plate ID that should be put (cross-

docked) to the shipping location. You can select any license plate ID of your choice.

5. Select OKOK.

6. On the next page, in the IDID field, enter the target license plate ID.

7. Select OKOK.

8. Confirm the work for picking the remaining quantity of 2, and then select OKOK.

9. On the next page, select DoneDone to end the picking process and begin the put-away process.

The mobile app presents you with the location and license plate to put the item to.

10. Confirm the bulk storage PutPut by selecting OKOK.



NOTENOTE

11. On the next page, confirm the cross-docking PutPut by selecting OKOK.

You receive a "Work Completed" message.

12. Select CancelCancel  to exit.

The following illustration shows how the completed cross-docking work might appear in Microsoft Dynamics

365 Supply Chain Management.
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Recommendation

Where reason codes apply

Set up reason code policies

Mandatory reason codes

Set up reason codes for warehousesSet up reason codes for warehouses

Reason codes let you analyze the results of a counting process and any discrepancies that occur during that

process. You can specify the reason for doing the count, such as a broken pallet or a stock adjustment that is

based on inventory samples.

Before you set up the system, we recommend that you define a strategy for working with reason codes. For

example, try to answer the following questions:

Should reason codes be mandatory on warehouses?

Should reason codes be mandatory or optional on some items?

How many reason codes do you require?

How should users of barcode scanners use reason codes? Should the reason codes be preselected,

mandatory, or not editable?

Do warehouse workers require different reason code behavior on mobile scanners? If the answer is yes, you

can create more menu items and assign them to different people.

You can create multiple reason code policies, and each reason code policy can have two counting reason code

policies. The counting reason code policies can be used at the warehouse level or the item level.

1. Select Inventor y managementInventor y management > SetupSetup > Inventor yInventor y  > Counting reason code policiesCounting reason code policies , and create

a new reason code policy.

2. In the Counting reason code typeCounting reason code type field, select either Mandator yMandator y  or OptionalOptional  to specify whether

selection of a reason code should be an optional or mandatory action in one of the following counting

journals:

Cycle Count (mobile device)

Spot Count (mobile device)

Threshold Count (mobile device)

Adjustment In (mobile device)

Adjustment Out (mobile device)

Counting Journal (rich client)

You can also set up reason codes for individual warehouses and for products. The reason code setup for

products can disregard the setup for warehouses.

If the Mandator yMandator y  parameter is set in the configuration of reason codes for warehouses or items, the counting

journal can't be completed and closed until a reason code is provided.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/reason-codes-for-counting-journals.md


Set up reason codes for productsSet up reason codes for products

Use reason codes in counting journalsUse reason codes in counting journals

View the counting history as it's recorded by reason codesView the counting history as it's recorded by reason codes

Use a reason code for a quantity adjustmentUse a reason code for a quantity adjustment

Configure reason codes for mobile device menu itemsConfigure reason codes for mobile device menu items

Set up reason codes on a mobile deviceSet up reason codes on a mobile device

1. Select Inventor y ManagementInventor y Management > SetupSetup > Inventor y breakdownInventor y breakdown > WarehousesWarehouses .

2. On the WarehouseWarehouse tab, in the Counting reason code policyCounting reason code policy  field, select one of the following options:

BlankBlank – The parameter that is set up for the item is used to determine whether counting journals are

mandatory for the product.

Mandator yMandator y  – A reason code is always required on counting journals for the warehouse.

OptionalOptional  – A reason code isn't required on counting journals for the warehouse.

1. Select Product information managementProduct information management > ProductsProducts  > Released productsReleased products .

2. On the ProductProduct tab, select Counting reason code policyCounting reason code policy , and then select one of the following options:

BlankBlank – The parameter that is set up for the warehouse is used to determine whether counting

journals are mandatory for the product.

Mandator yMandator y  – A reason code is always required on counting journals for the product. This setting

overrides any reason code setting at the warehouse level.

OptionalOptional  – A reason code isn't required on counting journals for the product. This setting overrides

any reason code setting at the warehouse level.

In a counting journal, you can add reason codes for counts of the following types:

Cycle Count

Spot Count

Threshold Count

Adjustment In

Adjustment Out

Reason codes are added to the journal lines in counting journals of the Counting journalCounting journal  type.

1. Select Inventor y managementInventor y management > Journal entr iesJournal entr ies  > Item countingItem counting > CountingCounting.

2. In the line details of the counting journal, in the Counting reason codeCounting reason code field, select an option.

Select Inventor y managementInventor y management > Inquir ies and repor tsInquir ies and repor ts  > Counting histor yCounting histor y , and then, in the

Counting reason codeCounting reason code field, view the counting history that has been recorded through a reason code.

1. On the On-hand inventor yOn-hand inventor y  page, select Adjust quantityAdjust quantity . You can open the On-hand inventor yOn-hand inventor y  page in

several ways. For example, select Inventor y managementInventor y management > Inquir ies and repor tsInquir ies and repor ts  > On-handOn-hand

inventor yinventor y .

2. Select Adjust quantityAdjust quantity , and then, in the Counting reason codeCounting reason code field, select a reason code.

You can configure reason codes for any type of count on a mobile device menu item. The configuration of the

mobile device menu item includes the following information:

Whether the reason code is shown to the mobile device worker during counting.

The default reason code that is shown on a mobile device menu item.

Whether the user can edit the reason code.

1. Select Warehouse managementWarehouse management > SetupSetup > Mobile deviceMobile device > Mobile device menu itemsMobile device menu items .



NOTENOTE

Cycle count approvals

Modify cycle count approvalsModify cycle count approvals

Modify the mobile device menu item for Adjustment in and Adjustment outModify the mobile device menu item for Adjustment in and Adjustment out

NOTENOTE

2. On the Cycle countCycle count tab, select Cycle countingCycle counting.

3. In the Default counting reason codeDefault counting reason code field, set the default reason code that should be recorded when

counting is done by using the mobile device menu item.

4. In the Display counting reason codeDisplay counting reason code field, select L ineLine to show the reason code after each variance is

recorded. Alternatively, select HideHide if the reason code shouldn't be shown.

5. Set the Edit counting reason codeEdit counting reason code option to either YesYes  or NoNo. If you set this option to YesYes , the worker can

edit the reason code when it's shown on the mobile device during counting.

The Cycle countingCycle counting button can be enabled on any mobile device menu item where counting can be done. Example

include the menu items for spot counts, user-directed work, and system-directed work.

Before a count is approved, the user can change the reason code that is associated with the count. When the

count is approved, the reason code is entered on the counting journal lines.

1. Select Warehouse managementWarehouse management > Cycle countingCycle counting > Cycle count work pending reviewCycle count work pending review .

2. Select Cycle countingCycle counting, and then, in the Reason codeReason code field, select a new reason code.

1. Select Warehouse managementWarehouse management > SetupSetup > Mobile deviceMobile device > Mobile device menu itemsMobile device menu items , and then

select Adjustment in and outAdjustment in and out.

2. Set the Use existing workUse existing work option to NoNo.

3. In the Work creation processWork creation process  field, select Adjustment inAdjustment in .

The following fields will be added to the mobile device menu item when Adjustment inAdjustment in or Adjustment outAdjustment out is

selected during the work creation process:

Default counting reason code

Display counting reason code

Edit counting reason code

Can you tell us about your documentation language preferences? Take a short survey.
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Blocking items manually

Blocking items by creating a quality order

NOTENOTE

Blocking items by using a process that generates a quality order

ExampleExample

This topic provides an overview of inventory blocking, which is part of the quality inspection process in Supply

Chain Management. You can use inventory blocking to prevent items from being processed or consumed.

You can block inventory items in the following ways:

Manually

By creating a quality order

By using a process that generates a quality order

By using inventory status blocking

You can block a quantity of an item by creating a transaction on the Inventor y blockingInventor y blocking page. Only items that

are available as on-hand inventory can be blocked manually. For manually blocked quantities, you must decide

whether planning activities include expected receipts as an expected on-hand quantity. Expected receipts are

blocked items that you expect to be available as on-hand inventory after inspection is completed. You can

maintain the expected date. By default, the Expected receiptsExpected receipts  option is selected for items that are blocked

through a quality order. You can cancel a manual block on a quantity by deleting the transaction on the

Inventor y blockingInventor y blocking page.

You can specify items that must be inspected by creating a quality order on the Quality ordersQuality orders  page. When you

create a quality order, the quantity that you specify for an item is blocked. The sampling plan that is associated

with a quality order controls only the quantity of items that must be inspected, not the quantity that is blocked.

The quantity that is entered on the quality order is the quantity that is blocked, regardless of the quantity that

the sampling plan specifies should be sent for inspection.

Using both the batch expiry date and blocking inventory status features is not supported by master planning. This could

result in double exclusion of on-hand inventory, which can occur during master planning. We recommend that you rely

on batch disposition codes, instead of inventory status, for blocking expired batches.

If a quality process specifies that an item must be inspected, a quantity of the item is blocked automatically.

Therefore, when a quality order is generated automatically, the item sampling plan that is associated with the

quality order controls the both quantity of items that is blocked and the quantity that must be inspected. If the

Full blockingFull blocking option on the Item samplingItem sampling page is selected, the full quantity of, for example, a purchase order

line is blocked during inspection, regardless of the item sampling quantity.

In the following example, a quality order is generated when a purchase order packing slip is posted. On the

Quality associationsQuality associations  page, you specified that posting of a purchase order packing slip is the process that

activates a quality order.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/inventory-blocking.md
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A quality association specifies that a
quality order must be generated when
a purchase order packing slip is
posted. The item sampling setup of
the quality order specifies that 10
percent of the quantity on the
purchase order line must be inspected.
Furthermore, because the FullFull
blockingblocking option selected in the item
sampling setup, the full quantity of the
purchase order line must be blocked
during inspection, regardless of the
quantity that is sent for inspection.

The packing slip is posted. A quality order is generated. Ten
percent of the purchase order quantity
for the item is sent to inspection. The
full quantity of the purchase order line
is blocked.

Blocking items by using inventory status blocking

Additional resources

NOTENOTE

You can specify which inventory statuses are blocking statuses by using the Inventor y blockingInventor y blocking parameter on

the Inventor y statusesInventor y statuses  page. You can't use inventory statuses as blocking statuses for production orders, sales

orders, transfer orders, outbound transactions, or project integrations. For outbound work, use items that have

an available inventory status. If items have a status of BrokenBroken, and master planning is run on those items, the

items are considered missing, and inventory is automatically replenished.

Create and maintain an inventory blocking

Quality management processes

Inspect the quality of goods

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Cycle counting prerequisites

This article describes how you can use cycle counting with the warehousing solution that is available in

Warehouse management. This article doesn't apply to the warehousing solution that's available in Inventory

management.

Cycle counting is a warehouse process that you can use to audit on-hand inventory items. The cycle counting

process can be described in three steps:

1. Create cycle counting workCreate cycle counting work – Cycle counting work can be created automatically, based on threshold

parameters for items or by using a cycle counting plan. Alternatively, you can manually create cycle counting

work by using the item or warehouse parameters on the Cycle count work by itemCycle count work by item page or the CycleCycle

count work by locationcount work by location page.

2. Process the cycle countProcess the cycle count – After cycle counting work is created, you do the cycle counting work by

counting items in a warehouse location and then using a mobile device to enter the result in Dynamics 365

Supply Chain Management. Alternatively, you can count items in a warehouse location without creating cycle

counting work. This process is referred to as spot cycle counting.

3. Resolve differences in the counted valueResolve differences in the counted value – After a cycle count, any items that have differences in the

counted value will have a work status of Pending reviewPending review  on the All workAll work page. You can resolve these

differences on the Cycle count work pending reviewCycle count work pending review  page.

The following illustration shows the cycle counting process. 

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/cycle-counting.md
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Item The item must be enabled for warehouse management
processes.

Warehouse The warehouse must be enabled for warehouse
management processes. To enable the warehouse for
warehouse management processes, on the WarehousesWarehouses
page, select the warehouse, and then select the UseUse
warehouse management processeswarehouse management processes option. To enable
workers to move pallets during a cycle count, on the
Warehouse managementWarehouse management  FastTab, select the Allow palletAllow pallet
moves during cycle countingmoves during cycle counting option.

Work pools Optional: Create a work pool to segregate the warehouse
work, based on the type of work (in this case, cycle counting
work).

Locations Enable cycle counting for locations. To enable cycle counting
for a warehouse location, on the Location profilesLocation profiles  page,
select the Allow cycle countingAllow cycle counting option.

Warehouse management parameters Set up parameters for cycle counting. On the WarehouseWarehouse
management parametersmanagement parameters  page, specify the default
adjustment type code, work class ID, and work priority for
cycle counting.

Mobile device

Related setup task Set up a cycle counting plan for a warehouse location.

Automatically create cycle counting work

Create cycle counting work, based on threshold parameters for itemsCreate cycle counting work, based on threshold parameters for items

The following table shows the prerequisites that must be in place before you can use cycle counting.

Create a menu item for one of the following methods
on the Mobile device menu itemsMobile device menu items page:

Set up a menu for the mobile device.

Create a work user account, and assign a mobile
device menu to the work user ID.

User directed cycle counting

System directed cycle counting

Cycle count grouping

Spot cycle counting

There are two ways to schedule recurring creation of cycle counting work: set up cycle counting thresholds or

set up cycle counting plans.

A cycle counting threshold indicates the quantity or percentage limit of inventory items. Cycle counting work

is automatically created when the threshold limit is reached.

A cycle counting plan creates cycle counting work either immediately or periodically through a batch job.

When cycle counting work is created, the counting work line includes information about the location to

count. The on-hand inventory that is associated with this location isn't blocked, and is therefore available for

reservation and outbound processing, even though open counting work exists.

Cycle counting work can be created when the number of items falls below a specific threshold value in a

location. For example, there are 60 items in a location that has a cycle counting threshold of 40. During a sales



Schedule cycle counting workSchedule cycle counting work

Create cycle counting work manually

Perform a cycle count by using a mobile device

Resolve cycle counting differences

order transaction, 25 items are picked from the location and put in a staging location. Because the new item

count, 35, is less than the threshold quantity, cycle counting work is automatically created for the location.

You can schedule cycle counting plans to create cycle counting work immediately or periodically. By setting up

cycle counting plans, you can control the work pool that cycle counting work is created for, the maximum

number of cycle counts that are created for items in different locations, and the number of days before a

warehouse location is counted again. For example, an item is available in three locations in the warehouse, and

the maximum number of cycle counts is set to 22 . In this case, when you run the cycle counting plan, two cycle

counts are created for the two locations where the item is present. As another example, you set the number of

days between cycle counts to 55 . In this case, cycle counting work is created every five days. However, if cycle

counting work is processed on day 3, the next cycle counting work will be created five days after the last cycle

counting was processed, on day 8.

To create cycle counting work manually, you can use the Cycle count work by itemCycle count work by item or Cycle count work byCycle count work by

locationlocation page. You can specify the maximum number of cycle counts to create. For example, if the warehouse

manager specifies a value of 55 , cycle counting work is created for five locations, even if the item is present in 10

locations. You can also select a work pool ID to assign the cycle counting work IDs that are created to. When a

work pool ID is processed for cycle counting, the cycle counting work IDs that are assigned to the work pool are

processed as a group.

There are several methods for processing cycle counting work by using Supply Chain Management on a mobile

device:

User directedUser directed – The worker can specify a cycle counting work ID that has a status of OpenOpen.

System directedSystem directed – Supply Chain Management assigns a cycle counting work ID to the worker.

Cycle count groupingCycle count grouping – The worker can group cycle counting work IDs that are specific to a particular

location, zone, or work pool.

Spot cycle countingSpot cycle counting – The worker can count items in a warehouse location at any time, without creating

cycle counting work. To perform spot cycle counting in a location, the worker enters the location ID.

The following example shows how you can perform spot cycle counting by using a mobile device. The

instructions that the worker sees on the device vary, depending on the setup of the menu item for spot cycle

counting.

1. On the mobile device, select the menu item to process spot cycle counting work.

2. Register the location to perform spot cycle counting for.

3. Register and confirm the item number and the counted item quantity. Note:Note: The status of the cycle counting

work is updated to either Pending reviewPending review  or ClosedClosed on the All workAll work page, depending on the parameters

that are set on the WorkerWorker  page.

4. Optional: Repeat step 3 for the remaining items in the location, and confirm that no additional items are

available for counting.

A cycle counting difference occurs in the following scenarios if the Is a cycle count super visorIs a cycle count super visor  option is set to

NoNo for a work user ID:

The counted value isn't within the deviation limits that are specified in the Maximum percentage limitMaximum percentage limit or

Maximum quantity limitMaximum quantity limit fields on the Work usersWork users  page. For example, the on-hand inventory quantity in a
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location is 50, and the deviation limit for the work user is 10. If the work user enters a value that isn't

between 40 and 60, a difference occurs.

The counted value differs from the on-hand inventory quantity, and no deviation limits are set.

You can adjust differences in the counted value and then accept the counted value on the Cycle count pendingCycle count pending

reviewreview  page. You can verify the modified count of the item quantity on the On hand by locationOn hand by location page. The

counted value is rejected if the difference can't be approved.

Set up mobile devices for warehouse work

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Set the priority of counting work

Enable the mobile device

Cycle counting is a warehouse process that you can use to audit on-hand inventory items. This task recording

shows how to set up the default counting work priority, enable a mobile device menu item to process both

picking and counting operations, enable a counting threshold trigger when a location becomes empty, and

enable a cycle counting plan for a specific item in a specific warehouse. Typically, these tasks are performed by a

warehouse manager. You can go through this procedure in the USMF demo data company or in your own data.

1. In the Navigation paneNavigation pane, go to Modules > Warehouse management > Setup > WarehouseModules > Warehouse management > Setup > Warehouse

management parametersmanagement parameters .

2. Click the Cycle countingCycle counting tab.

3. In the Default cycle count work pr ior ityDefault cycle count work pr ior ity  field, enter a number. This step changes the priority of cycle

counting work compared to other types of work in the warehouse. By entering a number that is lower than

the number for other types of work, you raise the priority of the cycle counting work.

4. Click SaveSave.

5. Close the page.

1. In the Navigation paneNavigation pane, go to Modules > Warehouse management > Setup > Mobile device >Modules > Warehouse management > Setup > Mobile device >

Mobile device menu itemsMobile device menu items .

2. Click NewNew .

3. In the Menu item nameMenu item name field, type a value.

4. In the TitleTitle field, type a value.

5. In the ModeMode field, select 'Work'.

6. Set the Use existing workUse existing work option to Yes. When you set this option to Yes, the system will look for existing

work when the mobile device menu item is used.

7. In the Directed byDirected by  field, select 'System directed'. When "System directed" is selected, the warehouse worker

will be directed to open work that is in defined work classes. (We will create these work classes next.)

8. Expand the Work classesWork classes  fastTab. Next, we will create two work classes that will be used with this mobile

device menu item. When the menu item is used, these work classes will be queried, and the work that has the

highest priority will be shown to the user.

9. Click NewNew .

10. In theWork class IDWork class ID field, select a value.

11. Click NewNew .

12. In the Work class IDWork class ID field, select a value.

13. In the Action PaneAction Pane, click SaveSave.

14. Close the page.

15. In the Navigation paneNavigation pane, go to Modules > Warehouse management > Setup > Mobile device >Modules > Warehouse management > Setup > Mobile device >

Mobile device menuMobile device menu.

16. In the list, find and select the desired record.

17. In the tree, select 'the menu item that you just created'.

18. Click EditEdit.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/tasks/define-cycle-counting-microsoft-dynamics-365-finance-operations-enterprise-edition-july-2017.md


Create a counting threshold

Create a cycle count plan

19. Click the arrow to add the menu item to the menu.

20. Click SaveSave.

1. In the Navigation paneNavigation pane, go to Modules > Warehouse management > Setup > Cycle counting >Modules > Warehouse management > Setup > Cycle counting >

Cycle count thresholdsCycle count thresholds .

2. Click NewNew .

3. In the Cycle counting threshold IDCycle counting threshold ID field, type a value.

4. Set the Process cycle counting immediatelyProcess cycle counting immediately  option to Yes.

5. In the Descr iptionDescr iption field, type a value.

6. Click SaveSave.

7. Click Select locationsSelect locations .

8. In the list, mark the selected row.

9. In the Criter iaCriter ia field, select a value.

10. Click OKOK.

11. Close the page.

1. In the Navigation paneNavigation pane, go to Modules > Warehouse management > Setup > Cycle counting >Modules > Warehouse management > Setup > Cycle counting >

Cycle count plansCycle count plans .

2. Click NewNew .

3. In the Cycle counting plan IDCycle counting plan ID field, type a value.

4. In the Descr iptionDescr iption field, type a value.

5. In the Maximum number of cycle countsMaximum number of cycle counts  field, enter a number.

6. Click SaveSave.

7. Click Select locationsSelect locations .

8. In the list, mark the selected row.

9. In the Criter iaCriter ia field, select a value.

10. Click OKOK.

11. In the Days between cycle countingDays between cycle counting field, enter a number. For example, if the Days between cycleDays between cycle

countingcounting field is set to 5, cycle counting work will be created every five days. However, if cycle counting

work is processed on day three, the next cycle counting work will be created five days after the last cycle

counting was processed, on day 8.

12. Click SaveSave.

13. Click NewNew .

14. In the Sequence numberSequence number  field, enter a number. The sort is from the smallest number to the largest number.

The value must be more than 0 (zero).

15. In the list, mark the selected row.

16. In the Descr iptionDescr iption field, type a value.

17. Click SaveSave.

18. Click Define productDefine product query.

19. In the list, mark the selected row.

20. In the Criter iaCriter ia field, enter or select a value.

21. Click OKOK.

22. Close the page.
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How to configure partial location cycle counting
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Example

Cycle count plans guide the actual counting operations. You can request that only specific products and product

variants be counted instead of all on-hand inventory in a location.

By using cycle count plans to create counting work, you can guide the actual counting operations. You can

request that only specific products and product variants be counted instead of all on-hand inventory in a

location. By filtering on specific products, the warehouse manager can reduce review overhead, avoid

consolidation mistakes, and save time.

When you use the warehouse work process for counting operations, a work header is created for each location.

When you define the cycle count plan, you can use the Select locationsSelect locations  query to limit the cycle counting work

that is created. When you select products for the cycle count plan, you can select both product and product

variant queries to refine what is counted.

You can associate a work templatework template with a cycle count plan to define how the cycle count work should be

created. The work template for counting operations is directly referenced from the cycle count plan.

When you define the work template details, you can use the Work line breaksWork line breaks  option to specify whether the

counting work lines must be grouped by item number or product variant number. This setup is required if you

want to count on-hand inventory only for specific products in a location. The cycle counting work lines that are

created will have the level of information that you define here, and the guided counting operation will be

handled based on this level.

If you associate cycle count plans with work templates by using the Work lines breaksWork lines breaks  option, the Par tialPar tial

cycle countcycle count field is selected for the cycle counting work that is created, and multiple cycle counting work lines

will be created based on the definition of the work template.

Before partial cycle count work can be processed, you must, at a minimum, select Display item numberDisplay item number  for

the mobile device menu item as part of the cycle counting setup. The warehouse operator will be asked to

record only counting information that is related to the counting lines (item numbers and product dimensions).

All other on-hand inventory will be ignored for this counting process.

For the partial cycle count process, the Last cycle countLast cycle count date/time won’t be updated for the location, even

though all the items on hand at a given location are counted. The partial cycle count doesn't consider the

parameter Days between cycle countingDays between cycle counting on the Cycle count plansCycle count plans  page. Partial cycle count doesn't

support simultaneous counting of multiple items at the same location. Partial cycle count functionality may

result in the same location being counted multiple times for an item when Process cycle counting planProcess cycle counting plan is

run. To avoid that scenario, specify filters in the Select locationsSelect locations  field.

The warehouse app doesn't provide the Add LP or itemAdd LP or item button when you use the partial cycle count process.

For this example, only item number A0001 must be counted in warehouse 61.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/partial-location-cycle-counting.md
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1. A new work template for cycle counting is created. The Work line breaksWork line breaks  option is used to group counting

work lines by item number. Therefore, the cycle counting work that is created will have lines per item number.

You can also group the lines by product variant number.

2. A new cycle counting plan is created that references the newly created work template. The cycle counting

plan includes all locations in warehouse 61 (Select locationsSelect locations  query) that hold inventory for item number

A0001. The selection of specific products is defined in the Cycle count product selectionsCycle count product selections  section.

3. You can select products for cycle counting plans by setting the Empty locationsEmpty locations  field to Exclude emptyExclude empty .

When the cycle counting plan is processed, partial cycle count work for item number A0001 is created. The

actual counting process can be performed by using a mobile device menu item for guided cycle counting.

Cycle counting
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Create a cycle counting work template

Create a cycle counting plan

When you use cycle count plans to create counting work, you can guide the actual counting operations by

requesting that only specific products and product variants be counted instead of all on-hand inventory at the

location. By filtering on specific products, the warehouse manager can reduce review overhead, help prevent

consolidation mistakes, and save time. Typically, a warehouse manager performs the setup tasks. You can go

through this procedure in the USMF demo data company or in your own data.

1. Go to Warehouse management > Setup > Work > Work templates.

2. In the Work order type field, select 'Cycle counting'.

3. Click New.

4. In the Sequence number field, enter a number.

5. In the list, mark the selected row.

6. In the Work template field, type a value.

7. In the Work template description field, type a value.

8. In the Work pool ID field, enter or select a value.

9. In the Work priority field, enter a number.

10. Click Save.

11. Click New.

12. In the list, mark the selected row.

13. In the Work type field, select 'Counting'.

14. In the Work class ID field, enter or select a value.

15. Click Save.

16. Click Work line breaks.

17. Click New.

18. In the Sequence number field, enter a number.

19. Click Save.

20. Close the page.

21. Close the page.

The sort order is from the smallest number to the largest number. The value must be more than 0

(zero).

The sort order is from the smallest number to the largest number. The value must be more than 0

(zero).

1. Go to Warehouse management > Setup > Cycle counting > Cycle count plans.

2. Click New.

3. In the Cycle counting plan ID field, type a value.

4. In the Description field, type a value.

5. In the Maximum number of cycle counts field, enter a number.

6. In the Work template field, enter or select a value.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/tasks/define-partial-location-cycle-counting-process.md
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7. Click New.

8. In the Sequence number field, enter a number.

9. In the Description field, type a value.

10. Click Save.

11. Click Define product query.

12. In the list, mark the selected row.

13. In the Criteria field, enter or select a value.

14. Click OK.

15. Close the page.

The sort order is from the smallest number to the largest number. The value must be more than 0

(zero).
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What the cleanup job does

Schedule and configure the cleanup job

The performance of queries that are used to calculate on-hand inventory is affected by the number of records in

the tables that are involved. One way to help improve the performance is to reduce the number of records that

the database must consider.

This topic describes the on-hand entries cleanup job, which deletes unneeded records in the InventSum and

WHSInventReserve tables. These tables store on-hand information for items that are enabled for warehouse

management processing. (These items are referred to as WHS items.) Deletion of these records can significantly

improve the performance of on-hand calculations.

The on-hand entries cleanup job deletes any records in the WHSInventReserve and InventSum tables where all

the field values are 0 (zero). These records can be deleted because they don't contribute to the on-hand

information. The job deletes only records that are below the LocationLocation level.

If negative physical inventory is allowed, the cleanup job might not be able to delete all the relevant entries. The

reason for this limitation is that the job must allow for a special scenario where a license plate has multiple serial

numbers, and one of those serial numbers has become negative. For example, the system will have zero on

hand at the license plate level when a license plate has +1 pcs of serial number 1 and –1 pcs of serial number 2.

For this special scenario, the job does a breadth-first deletion, where it tries to delete from lower levels first.

The on-hand entries cleanup job is available at Inventor y management > Periodic tasks > Clean up >Inventor y management > Periodic tasks > Clean up >

Warehouse management on-hand entr ies cleanupWarehouse management on-hand entr ies cleanup. Use the standard job settings to control the scope and

schedule for running the job. In addition, the following settings are provided:

Delete if not updated for this many daysDelete if not updated for this many days  – Enter the minimum number of days that the job should wait

before it deletes an on-hand entry that has dropped to zero quantity. Use this setting to help reduce the risk

of deleting on-hand entries that are still being used. If you want cleanup to occur as soon as possible, either

enter 0 (zero) or leave the field blank.

Maximum execution time (hours)Maximum execution time (hours)  – Enter the maximum execution time of the cleanup job, in hours. If the

job isn't completed before this time passes, it will save the work that it has completed so far and then close

itself. This capability is especially relevant for implementations that have high inventory use. In these cases,

you should schedule the job to run at times when the system load is as light as possible. If you want the

batch job to continue to run until it's completed, either enter 0 (zero) or leave the field blank. This setting is

available only if the related feature has been turned on in your system.

Although you can run the job during regular business hours, we recommend that you run it outside working

hours. In this way, you help prevent conflicts that can occur if a user is working with a record that is also being

cleaned up.

If the job tries to delete a record for an item while that record is being used by another user, a deadlock error

occurs for either the cleanup job or the user.

When the job runs, it has a commit size of 100. In other words, it will try to commit one time for every 100

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/onhand-cleanup.md
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Make the Maximum execution time setting available
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deletions. However, because some deletions are set-based, there might be scenarios where more than 100

records can be deleted in the same transaction. Therefore, lock escalations can still sometimes occur.

Users might be affected if the on-hand entries cleanup job deletes all the records for a given level (such as the

license plate level). In this case, the functionality for seeing that inventory was previously available on-hand at a

license plate might not work as expected because the relevant on-hand entries are no longer available. This can,

for example, be experienced in the following situations:

On the On-hand listOn-hand list, when the user deselects the condition Quantity <> 0Quantity <> 0  or selects the condition ClosedClosed

transactionstransactions  in the Dimensions displayDimensions display  settings.

In a Physical inventor y by inventor y dimensionPhysical inventor y by inventor y dimension report for past periods, when the user sets the As ofAs of

datedate parameter.

However, the performance improvement that the cleanup job provides should make up for these small losses in

functionality.

By default, the Maximum execution timeMaximum execution time setting isn't available. If you want to use it, you must use feature

management to turn on the related feature in your system. In the Feature managementFeature management workspace, the

feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Maximum execution time for the warehouse management on-hand entries cleanup job

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Types of inventory journals

MovementMovement

Inventory adjustmentInventory adjustment

TransferTransfer

BOMBOM

This topic describes how you can use inventory journals to post various types of physical inventory transactions.

The inventory journals in Supply Chain Management are used to post physical inventory transactions of various

types, such as the posting of issues and receipts, inventory movements, the creation of bills of materials (BOMs),

and the reconciliation of physical inventory. All these inventory journals are used in a similar way, but they are

divided into different types.

The following types of inventory journals are available:

Movement

Inventory adjustment

Transfer

BOM

Item arrival

Production input

Counting

Tag counting

When you use an inventory movement journal, you can add cost to an item when you add inventory, but you

must manually allocate the additional cost to a particular general ledger account by specifying a general ledger

offset account when you create the journal. This inventory journal type is useful if you want to overwrite the

default posting accounts.

When you use an inventory adjustment journal, you can add cost to an item when you add inventory. The

additional cost is automatically posted to a specific general ledger account, based on the setup of the item group

posting profile. Use this inventory journal type to update gains and losses to inventory quantities when the item

should keep its default general ledger offset account. When you post an inventory adjustment journal, an

inventory receipt or issue is posted, the inventory values are changed, and ledger transactions are created.

You can use transfer journals to transfer items between stocking locations, batches, or product variants without

associating any cost implications. For example, you can transfer items from one warehouse to another

warehouse within the same company. When you use a transfer journal, you must specify both the "from" and

"to" inventory dimensions (for example, for Site and Warehouse). The on-hand inventory for the defined

inventory dimensions is changed accordingly. Inventory transfers reflect the immediate movement of material.

In-transit inventory isn't tracked. If in-transit inventory must be tracked, you should use a transfer order instead.

When you post a transfer journal, two inventory transactions are created for each journal line:

An inventory issue at the "from" location.

An inventory receipt at the "to" location.

When you report a BOM as finished, you can create a BOM journal. By using a BOM journal, you can post the

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/inventory-journals.md


Item arrivalItem arrival

Production inputProduction input

CountingCounting

Tag countingTag counting

Working with journals

Posting journal lines

Data entity support for inventory journals

BOM directly. This posting generates an inventory receipt of the product, together with an associated BOM and

an inventory issue of the products that are included in the BOM. This inventory journal type is useful in simple

or high-volume production scenarios where routes aren't required.

You can use the item arrival journal to register the receipt of items (for example, from purchase orders). An item

arrival journal can be created as part of arrival management from the Arr ival over viewArr ival over view  page, or you can

manually create a journal entry from the Item arr ivalItem arr ival  page. If you enable the item arrival journal name to check

for picking locations, Supply Chain Management looks for a location for received items and, if there is room,

generates location destinations for the incoming items.

Production input journals work like the item arrival journals but are used for production orders.

Counting journals let you correct the current on-hand inventory that is registered for items or groups of items,

and then post the actual physical count, so that you can make the adjustments that are required to reconcile the

differences. You can associate counting policies with counting groups to help group items that have various

characteristics, so that those items can be included in a counting journal. For example, you can set up counting

groups to count items that have a specific frequency, or to count items when stock falls to a particular level. For

information about how to define counting groups, see Define inventory counting processes.

Tag counting journals are used to assign a numbered tag to a count lot. The tag should contain a tag number,

item number, and item quantity. To ensure that a tag is used only one time, and that all tags are used, every item

number should have a unique set of tags that has its own number sequence. Three status values can be set for

each tag:

UsedUsed – The item number is counted for this tag.

VoidedVoided – The item number is voided for this tag.

MissingMissing – The item number is missing for this tag.

When you post a tag counting journal, a new counting journal is created, based on the tag counting journal

lines. For more information about tag counting, see Inventory tag counting.

A journal can be accessed by only one user at a time. If several users must access journals at the same time to

create journal lines, those users must select journals that aren't currently being used, to prevent information

from being overwritten. In situations where multiple departments use the same journal type, it's helpful to

create multiple journal names (for example, one per department). It can also be helpful to divide journals so that

each posting routine is entered in its own unique inventory journal. For posting routines that are associated with

inventory transactions, create one journal for periodic inventory adjustments and another for inventory

counting.

You can post the journal lines that you create at any time until you've locked an item from additional

transactions. The data that you enter in a journal remains in that journal, even if you close the journal without

posting the lines.

Data entities support the following types of integration scenarios:
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Synchronous service (OData)

Asynchronous integration

For more information, see Data entities.

Not all inventory journals are OData-enabled, therefore you cannot use the Excel data connector to get data published,

updated, and imported back to Supply Chain Management.

Another difference between the journal data entities is the ability to use composite entities that include both the

header and line data. Currently, you can use the composite entities for :

Inventory adjustment journal

Inventory movement journal

These two inventory journals only support the Initialize stock scenario as part of a data management import

project:

When a journal header number is not specified, but a number sequence is specified for the journal type, the

import job will automatically create journal headers per 1000 lines. For example, importing 2020 lines will

result in the following three journal headers:

It is assumed that unique line information exists per inventory dimension, which can be a product, storage,

and tracking dimension. Therefore, it’s not possible to import journal lines where only the date field differs

on the lines within the same import project.

Header 1: will contain 1000 lines

Header 2: will contain 1000 lines

Header 3: will contain 20 lines

Data entities
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Sort codes

Blocked locations

Tree structure

Maintain inventory locations via the warehouse form

Additional resources

Inventory locations are used with basic warehousing (WMS I) to determine where items are stored and where

items are picked from in a WMS I warehouse.

This topic applies to features in the Inventory management module. It does not apply to features in the

Warehouse management module.

The term location refers to the place that items are stored and drawn from.

For each location, the place where the item is inserted can also be specified. By default, they are the same. Items

are usually inserted and drawn from the same side of a location, but not always. For example, items that are

stored in live storage racks are inserted from one aisle and drawn from another. The main input is given by a

location name, which is usually determined by its coordinates: warehouse, aisle, rack, shelf, and bin. This name

or ID can be entered manually or generated from the location coordinates—for example, 01-02-03-4 for aisle 1,

rack 2, shelf 3, bin 4 in the Inventory locations page. Location properties

A location has the following characteristics:

Size (height, width, depth, and thereby volume)

Warehouse, aisle, rack, shelf, and bin position

Location type (bulk location, picking location, inbound dock, outbound dock, production input location,

inspection location, or kanban supermarket)

Check text can be used in online systems to verify that the operator has selected the correct location for a

specific item. This check text can be created manually or by default.

Use sort codes to optimize the handling of picking lines, which describe the information that is required for

picking items from inventory, including the picking order. Sort codes can be specified by the aisle and other

coordinates, or assigned manually for the location.

Occasionally, you might want to indicate that a location is blocked for a period of time, for example, to allow for

repairs. At other times, you may want to indicate blocking of only the input or only output.

In the Inventory locations page, you can view the warehouse layout in a tree structure based on the coordinates

of inventory locations, in a defined display format.

It is possible to copy locations from one warehouse to another and to create locations via a wizard. Before you

run the wizard you should make sure that you have defined the default location names on the Warehouse page.

Create a new warehouse layout

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/inventory-locations.md
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Set up and use inventory statuses
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This article describes how you can use inventory statuses to categorize and keep track of inventory.

You can use inventory statuses to categorize inventory. You can then initiate appropriate actions, such as

replenishment or put-away work.

Here are some examples of ways that you can use inventory statuses:

Create inventory statuses for on-hand inventory, inbound transactions, and outbound transactions.

Specify a default inventory status for warehouse transactions.

Change an inventory status for items before arrival, during arrival, or when the items are put away during

inventory movement.

Use an inventory status to price items that are returned and to plan item coverage during master planning.

An inventory status is one of the dimensions in the storage dimension group. Inventory statuses can be

categorized as available or unavailable, and you can use the Inventor y blockingInventor y blocking parameter to block items that

have an unavailable inventory status. Items that have a blocked status are considered physical inventory, and

they can't be used on a production order, sales order, transfer order, or outbound transaction.

You can use warehouse items that have either available or unavailable inventory statuses for inbound work. For

example, you create an available status that is named Ready, an unavailable status that is named Damaged, and

a blocked status that is named Blocked. When you create a purchase order for received or returned items, if any

items are damaged or broken, you can change the inventory status of those items to Damaged on the purchase

order line. After these items are received, the status is automatically set to Blocked. If you scan the damaged

items by using a mobile device, Supply Chain Management can use location directives and work templates to

show information about an appropriate location or range of locations where you can put away those items. For

returned items, an issue type of Reservation is created on the Inventor y transactionsInventor y transactions  page.

You can't change the status of inventory at locations where open work exists. For example, if you did a purchase receive

for an item, but didn't do the putaway step, then open work would exist for the receiving location and you would get an

error if you tried to change the status of inventory at that location. Completing or cancelling the related work would allow

you to change the status.

For outbound work, use items that have an available inventory status. If you have items that have a status of

Broken, and master planning is run on these items, the items are considered missing, and inventory is

automatically replenished.

After you set up inventory statuses, you can set the default inventory status for a site, item, and warehouse. You

can also set a default status for sales, transfer, and purchase orders. The default status for sales orders and

outbound transfer order can't have the Inventor y blockingInventor y blocking option set to Yes. The inventory status that is

inherited from the default settings on a site, warehouse, item, purchase order, transfer order or sales order can

be changed by using the mobile device, or on the purchase order, sales order, or transfer order line.

To plan coverage for items that have an available inventory status, select the Coverage plan by dimensionCoverage plan by dimension

option for a storage dimension on the Storage dimension groupsStorage dimension groups  page. When you open the Item CoverageItem Coverage
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wizard, items that have an available status appear on the StatusStatus  page. To create coverage settings for these

items, select the inventory status ID for the available inventory statuses. Based on the coverage settings, you can

calculate the item requirements and forecast the supply and demand of available items during master planning.

You can't create an item coverage setup that has a blocked inventory status. Alternatively, use the ItemItem

coveragecoverage page to create or modify the item coverage parameters.

You can change inventory statuses either by using the On-hand by locationOn-hand by location page or by using the Inventory

status change periodic task.

When using the Inventory status change periodic task, you can select which records to include and set the

task to run in the batch at the desired interval.

To change inventory status as an ad-hoc process, go to On-hand by locationOn-hand by location page, select the relevant

records, and then select the Inventor y status changeInventor y status change button.

The Change the inventory status of items controlled by tracking dimensions feature allows you to change the inventory

status of items controlled by tracking dimensions, including the ability to update only selected records. Use feature

management to enable the feature as needed. When the feature is enabled, you'll be able to do the following:

On the On-hand by locationOn-hand by location page, you can group lines based on shown dimensions using the DisplayDisplay

dimensionsdimensions button and change the status for the selected lines.

On the On-hand by locationOn-hand by location page, you can select multiple records and then use the Inventor y status changeInventor y status change

button to change all of them at once.

On the Inventor y status changeInventor y status change periodic task you will be able to filter by tracking dimensions.
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This topic provides information about tag counting, which you use to compare the actual contents of a

warehouse with the on-hand inventory.

By creating lines on the Tag countingTag counting page, you place a tag number on each inventory item, such as a number

from 1 to 500. During the count, you enter the item number and the quantity on a corresponding tag. This tag

can then be used as the basis for input in the tag counting journal. After you post the tag counting journal, a new

counting journal is created on the CountingCounting page. The new journal is based on the tag counting journal lines

that you created. To tag-count items by a specific inventory dimension, select the dimension on the DisplayDisplay

dimensiondimension page that is displayed when you create the tag counting journal. For example, to count items in a

specific warehouse, select the WarehouseWarehouse check box. If the Lock items during countLock items during count slider on the Inventor yInventor y

and warehouse management parametersand warehouse management parameters  page is selected, items can't be physically updated during

counting. However, items in tag counting journals aren't locked during counting. Inventory transactions aren't

created until the tag counting lines are posted and transferred to a counting journal. If tags are entered

randomly, and you want to identify missing tags, click the TagTag column header to sort the lines by tag.

Cycle counting
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Turn on the work line details feature

Open and use the Work line details page

Try out the feature

Make sample data availableMake sample data available

Verify that the scenario setup includes enough available inventoryVerify that the scenario setup includes enough available inventory

The Work line detailsWork line details  page shows a comprehensive, sortable, and filterable list of the individual work lines in

your system. It provides a complete overview of work that is being planned and executed in the warehouse. You

can easily switch between viewing all work lines and viewing only open work lines. Details that are provided for

each line include the work status, item number, location, work quantity, load ID, and shipment ID.

Before you can use this feature, it must be turned on in your system. Admins can use the feature management

settings to check the status of the feature and turn it on if it's required. In the Feature managementFeature management

workspace, the feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Work line details

To view the list of work line details, go to Warehouse management > Work > Work line detailsWarehouse management > Work > Work line details . From

here, you can perform the following actions:

Use the FilterFilter  field to search for lines that have a specific value for any available parameter. (Available

parameters include many parameters that aren't shown as columns in the grid.)

Use the Show closedShow closed check box to show or hide closed lines.

Select Display dimensionsDisplay dimensions  to open the Dimensions displayDimensions display  dialog box, where you can choose to show or

hide various dimension columns in the grid.

Select any column heading to open a menu where you can choose to sort or filter the list by values in that

column.

Select a work line, and then select Change locationChange location to open a dialog box where you can change the location

for that work line. The location that you specify will override the setup of the location directive.

Select a work line, and then select Cancel work lineCancel work line to open a dialog box where you can partially or fully

reduce the quantity of that work line.

Adjust quantities.

View the transactions behind any work line.

This section provides a three-part demo that shows how to work with work line details.

To work through this demo by using the sample records and values that are specified here, you must be on a

system where the standard demo data is installed. Additionally, you must select the USMFUSMF legal entity before

you begin.

You can also use this demo as guidance when you work on a production system. However, you must substitute

your own values, and you might be missing some types of required records that the standard demo data

provides.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/work-line-details.md


Part 1: Create picking workPart 1: Create picking work

Part 2: Change the location for a work linePart 2: Change the location for a work line

If you're working with the USMFUSMF demo data, you should first make sure that your system is set up so that

enough inventory is available at each relevant pick location. For this demo, the expectation is that you have the

following inventory available:

Item M9200:Item M9200: 45 ea. (or more)

Item M9202:Item M9202: 10 ea. (or more)

Follow these steps to verify that enough inventory is available and to make any adjustments that are required.

1. Go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives , and determine which picking locations

are used for sales order picking at warehouse 51. (For more information, see Control warehouse work by

using work templates and location directives.)

2. Check the inventory levels at the relevant locations.

3. Adjust inventory as required. You can create manual movements, use replenishment, or apply any other flow

to adjust the inventory.

Before you start to create work, make sure that your warehouse is set up to respond to work requests in the

expected manner.

Follow these steps to create some picking work.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. Select NewNew  to open the Create sales orderCreate sales order  dialog box.

3. In the Create sales orderCreate sales order  dialog box, set the following values:

On the CustomerCustomer  FastTab, set the Customer accountCustomer account field to US-001.

On the GeneralGeneral  FastTab, set the WarehouseWarehouse field to 51.

4. Select OKOK to create the sales order and close the dialog box.

5. Your new sales order is opened. It includes a new, empty row in the Sales order linesSales order lines  grid. On this order

line, set the following values:

Item number :Item number : M9200

Quantity:Quantity: 20

Unit:Unit: ea

6. Select the new order line, and then, on the Inventor yInventor y  menu, select Reser vationReser vation to open the

Reser vationReser vation page.

7. On the Reser vationReser vation page, select Reser ve lotReser ve lot to reserve the selected line's full quantity in the

warehouse.

8. Close the Reser vationReser vation page to return to the sales order.

9. On the Action Pane, on the WarehouseWarehouse tab, select Release to warehouseRelease to warehouse. The system creates a

shipment, adds it to a new load, and creates the required work.

10. Create a second sales order for the same customer account and warehouse that you used for the first

order. Add the following two order lines to this order :

L ine 1:L ine 1: Set the Item numberItem number  field to M9200, the QuantityQuantity  field to 25, and the UnitUnit field to ea.

L ine 2:L ine 2: Set the Item numberItem number  field to M9202, the QuantityQuantity  field to 10, and the UnitUnit field to ea.

11. Repeat steps 6 through 8 to reserve the inventory for each order line (one at a time), and then repeat step

9 to release the order to the warehouse.



IMPORTANTIMPORTANT

Part 3: Change the quantity of a work line or cancel a work linePart 3: Change the quantity of a work line or cancel a work line

IMPORTANTIMPORTANT

NOTENOTE

1. Go to Warehouse management > Work > Work line detailsWarehouse management > Work > Work line details .

2. Find and select one of the work lines that you created for this demo.

3. Select Change locationChange location to open the Select new locationSelect new location dialog box.

4. In the Select new locationSelect new location dialog box, in the LocationLocation field, select a new location for the work line.

5. Select OKOK to apply your change and close the dialog box.

You can submit location changes only if the new location has enough inventory available (for a pick), or if it passes

location-type validation (for a put).

1. Go to Warehouse management > Work > Work line detailsWarehouse management > Work > Work line details .

2. Find and select one of the work lines that you created for this demo. Note that you can cancel or change

quantities only for work lines where the work type is pick.

3. Select Cancel work lineCancel work line to open the Quantity to cancelQuantity to cancel  dialog box.

4. In the Quantity to cancelQuantity to cancel  dialog box, change the value in the QuantityQuantity  field to specify the quantity that

should be subtracted from the quantity that is currently specified for the line. By default, the QuantityQuantity

field shows the full quantity.

If you cancel the full quantity, the Work statusWork status  value will be changed to Canceled, but the WorkWork

quantityquantity  field will still show the original value.

If you cancel just part of the quantity, the Work quantityWork quantity  field will be updated to show the new value,

but the Work statusWork status  value won't change.

5. Select OKOK to apply your change and close the dialog box.

If you cancel just part of the quantity for a work line, you must also remove the obsolete quantity from the load line.

Otherwise, unless under-delivery is set up correctly, the load line can't be ship-confirmed.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
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Location license plate positioning
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Turn on the Location license plate positioning feature

Example scenario
Make sample data availableMake sample data available

Set up the feature for this scenarioSet up the feature for this scenario

Location profilesLocation profiles

Location directivesLocation directives

License plate location positioning lets you see where a license plate is located in a multi-pallet location, such as a

location that uses double-deep pallet racking.

The feature adds a sequence number to each license plate that is put into a storage location. This sequence

number is used to order the license plates in the storage location. Therefore, the feature intelligently supports

scenarios where customers are using a gravity racking system and must know, for picking purposes, which

license plate is front-facing.

This topic presents a scenario that shows how to set up and use the feature.

Before you can use license plate location positioning, the feature must be turned on in your system. Admins can

use the Feature management workspace to check the status of the feature and turn it on if it's required. There,

the feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Location license plate positioning

To work through this scenario by using the values that are suggested here, you must work on a system where

sample data is installed. Additionally, you must select the USMFUSMF legal entity before you start.

Complete the following procedures to set up the Location license plate positioning feature for the scenario that

is presented in this topic.

The feature must be turned on in the location profile for every location where it will be used.

1. Go to Warehouse management > Setup > Warehouse > Location profilesWarehouse management > Setup > Warehouse > Location profiles .

2. In the list of location profiles in the left pane, select BULK-06BULK-06 .

3. On the GeneralGeneral  FastTab, two new options have been added by the feature. Set the following values:

Enable license plate position:Enable license plate position: Yes

When this option is set to Yes, the license plate position will be maintained for license plates in the

location.

Display mobile device LP position:Display mobile device LP position: Yes

When this option is set to Yes, the license plate position will be shown to mobile device users

during adjustment and counting. You can change the setting of this option only when the feature is

turned on.

4. Select SaveSave.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/location-license-plate-positioning.md


1. Go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives .

2. In the left pane, make sure that the Work order typeWork order type field is set to Sales orders.

3. In the list of location directives, select 61 SO Pick order61 SO Pick order .

4. On the Action Pane, select EditEdit.

5. On the L inesLines  FastTab, select the line that has a Sequence numberSequence number  value of 2.

6. On the Location Directive ActionsLocation Directive Actions  FastTab, select the line that has a NameName value of Pick for less than

pallet (it should be the only line), and change its Sequence numberSequence number  value to 2.

7. Select NewNew  above the grid to add a line for a new location directive action.

8. On the new line, set the following values:

Sequence number :Sequence number : 1

Name:Name: Pick position 1

9. While the new line is still selected, select Edit quer yEdit quer y  above the grid.

10. In the query editor, select the JoinsJoins  tab.

11. Expand the LocationsLocations  table join to show the join to the Inventor y dimensionsInventor y dimensions  table.

12. Expand the Inventor y dimensionsInventor y dimensions  table join to show the join to the On-hand inventor yOn-hand inventor y  table.

13. Select Inventor y dimensionsInventor y dimensions , and then select Add table joinAdd table join .

14. In the list of tables that appears, in the RelationRelation column, select L icense plate (L icense plate)L icense plate (L icense plate) . Then

select SelectSelect to add L icense plateLicense plate to the Inventor y dimensionsInventor y dimensions  table join.

15. While L icense plateLicense plate is still selected, select Add table joinAdd table join .

16. In the list of tables that appears, in the RelationRelation column, select Location license plate positioningLocation license plate positioning

(L icense plate)(L icense plate) . Then select SelectSelect to add Location license plate positioningLocation license plate positioning to the Inventor yInventor y

dimensionsdimensions  table join.

17. Select OKOK to confirm the updated joined tables and close the query editor.

18. On the Location Directive ActionsLocation Directive Actions  FastTab, select Edit quer yEdit quer y  again to reopen to the query editor.

19. On the RangeRange tab, select AddAdd to add a line to the grid.

20. On the new line, set the following values:

Table:Table: Location license plate positioning

Derived table:Derived table: Location license plate positioning

Field:Field: LP Position

Criter ia:Cr iter ia: 1



Set up sample data for this scenarioSet up sample data for this scenario

Spot-count the first locationSpot-count the first location

21. Select OKOK to confirm your changes and close the query editor.

For this scenario, the user must sign in to the warehousing mobile app by using a worker who is set up for

warehouse 61 to perform work. The user must also complete transactions.

Because the Location license plate positioning feature adds a new identifier for license plate positions in a

location, you must first create some data to support the scenario.

1. Open the warehousing mobile app, and sign in to warehouse 61.

2. Go to Inventor y > Spot CountingInventor y > Spot Counting.

3. On the Spot CountingSpot Counting page, set the LocationLocation field to 01A01R1S1B.

4. Select OKOK.

The page shows the location that you entered. It also shows the following message: "Location complete,

add new LP or Item?"

5. Select RefreshRefresh to add a count in the location.

6. On the Cycle Count: Add New LP or ItemCycle Count: Add New LP or Item page, select the ItemItem field, and then enter the value A0001.

7. Select OKOK.

8. On the Cycle Count: Add New LP or ItemCycle Count: Add New LP or Item page, select the LPLP field, and then enter the value LP1001

(or any other license plate number of your choice).

The Cycle Count: Add New LP or ItemCycle Count: Add New LP or Item page shows L icense Plate Position 1License Plate Position 1 .

9. Select OKOK.

You must now specify the quantity of the item that is counted on the license plate.

10. Set the QtyQty  field to 10.

11. Select OKOK.

The page shows the location that you entered. It also shows the following message: "Location complete,

add new LP or Item?"

12. Select RefreshRefresh to add another count in the location.

13. On the Cycle Count: Add New LP or ItemCycle Count: Add New LP or Item page, select the ItemItem field, and then enter the value A0002.

14. Select OKOK.

15. On the Cycle Count: Add New LP or ItemCycle Count: Add New LP or Item page, select the LPLP field, and then enter the value LP1002

(or any other license plate number of your choice, provided that it differs from the license plate number

that you specified earlier).



Spot-count the second locationSpot-count the second location

Work detailsWork details

NOTENOTE

16. Change the license plate position by setting the LP PositionLP Position field to 2.

17. Select OKOK.

18. Specify the quantity of the item that is counted on the license plate by setting the QtyQty  field to 10.

19. Select OKOK.

The page shows the location that you entered. It also shows the following message: "Location complete,

add new LP or Item?"

20. Select OKOK.

Work is now completed.

1. On the Spot CountingSpot Counting page, set the LocationLocation field to 01A01R1S2B.

2. Select OKOK.

The page shows the location that you entered. It also shows the following message: "Location complete,

add new LP or Item?"

3. Select RefreshRefresh to add a count in the location.

4. On the Cycle Count: Add New LP or ItemCycle Count: Add New LP or Item page, select the ItemItem field, and then enter the value A0002.

5. Select OKOK.

6. On the Cycle Count: Add New LP or ItemCycle Count: Add New LP or Item page, select the LPLP field, and then enter the value LP1003

(or any other license plate number of your choice, provided that it differs from the both the license plate

numbers that you specified in the previous procedure).

The Cycle Count: Add New LP or ItemCycle Count: Add New LP or Item page shows L icense Plate Position 1License Plate Position 1 .

7. Select OKOK.

8. Specify the quantity of the item that is counted on the license plate by setting the QtyQty  field to 10.

9. Select OKOK.

The page shows the location that you entered. It also shows the following message: "Location complete,

add new LP or Item?"

10. Select OKOK.

Work is now completed.

Spot counts from the mobile app create cycle counting work in Microsoft Dynamics 365. The work requires that the

counts be accepted before they are posted to inventory.

1. Sign in to Dynamics 365 Supply Chain Management.

2. Go to Warehouse management > Work > Work detailsWarehouse management > Work > Work details .

3. On the Over viewOver view  tab, look for the lines that have the following values:

Work order type:Work order type: Cycle counting

Warehouse:Warehouse: 61



On-hand by locationOn-hand by location

TIPTIP

TIPTIP

Work status:Work status: Pending review

Two work IDs should have been created for these lines. The counts for both these work IDs must be

accepted.

4. In the grid, select the first work ID for the Cycle counting work order type.

5. On the Action Pane, on WorkWork tab, in the WorkWork group, select Cycle countingCycle counting.

Two lines are shown, one for each item and license plate. The values in the Counted quantityCounted quantity , LocationLocation,

L icense plateLicense plate, and ItemItem fields should match the count entries that you created on the mobile device. If

any of these fields aren't visible, select Display dimensionsDisplay dimensions  on the Action Pane to add them to the grid.

6. Select both lines.

7. On the Action Pane, select Accept countAccept count.

8. You receive a "Posting - Journal" message. Select Message detailsMessage details  to view the posted journal number.

9. Close the message details.

10. Refresh the WorkWork page.

The first work ID has been closed and is no longer shown.

To view closed work, select the Show closedShow closed check box above the grid.

You will now accept the work for the license plate in the 01A01R1S2B location.

11. On the Over viewOver view  tab, select the second work ID for the Cycle counting work order type.

12. On the Action Pane, on WorkWork tab, in the WorkWork group, select Cycle countingCycle counting.

One line is shown, for the item and license plate. The values in the Counted quantityCounted quantity , LocationLocation,

L icense plateLicense plate, and ItemItem fields should match the count entries that you created on the mobile device.

13. Select the line.

14. On the Action Pane, select Accept countAccept count.

15. You receive a "Posting - Journal" message. Select Message detailsMessage details  to view the posted journal number.

16. Close the message details.

17. Refresh the WorkWork page.

The second work ID has been closed and is no longer shown.

To view closed work, select the Show closedShow closed check box above the grid.

1. Go to Warehouse management > Inquir ies and repor ts > On-hand by locationWarehouse management > Inquir ies and repor ts > On-hand by location.

2. Set the following values:

S ite:S ite: 6

Warehouse:Warehouse: 61



Sales order scenarioSales order scenario

Sales picking scenarioSales picking scenario

Refresh across locations:Refresh across locations: Yes

3. Notice that location 01A01R1S1B has two license plates:

A0001A0001 , where the LP PositionLP Position field is set to 1

A0002A0002 , where the LP PositionLP Position field is set to 2

4. Notice that location 01A01R1S2B has one license plate:

A0002A0002 , where the LP PositionLP Position field is set to 1

Now that the Location license plate positioning feature has been set up, and the inventory has been staged, you

must create a sales order to generate picking work that will direct the warehouse worker to pick item A0002

from the inventory location where the pallet ID is in position 1.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. On the Action Pane, select NewNew .

3. In the Create sales orderCreate sales order  dialog box, set the following values:

Customer account:Customer account: US-004

Warehouse:Warehouse: 61

4. Select OKOK.

5. A new line is added to the grid on the Sales order linesSales order lines  FastTab. On this new line, set the following

values:

Item number :Item number : A0002

Quantity:Quantity: 1

6. On the Inventor yInventor y  menu above the grid, select Reser vationReser vation.

7. On the Reser vationReser vation page, on the Action Pane, select Reser ve lotReser ve lot to reserve inventory for the order line.

8. Close the Reser vationReser vation page.

9. On the Action Pane, on the WarehouseWarehouse tab, in the ActionsActions  group, select Release to warehouseRelease to warehouse.

You receive an informational message that indicates the wave ID and shipment ID that were created for

the order.

10. On the Sales order linesSales order lines  FastTab, on the WarehouseWarehouse menu above the grid, select Work detailsWork details .

11. The WorkWork page appears and shows the work that was created for the sales line. Make a note of the work

ID that is shown.

1. Open the mobile app, and sign in to warehouse 61.

2. Go to Outbound > Sales pickingOutbound > Sales picking.

3. On the Scan a work ID / license plate IDScan a work ID / license plate ID page, select the IDID field, and then enter the work ID from the

sales line.

4. Notice that the picking work directs you to pick item A0002 from location 01A01R1S2B. You receive this

instruction because item A0002 is on a license plate that is in position 1 in that location.



NOTENOTE

5. Enter the license plate ID that you created for the location, and then follow the prompts to pick the sales

order.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Turn on the Change work pool on work feature

Set up the Change work pool on work feature

Set up work poolsSet up work pools

Set up work templatesSet up work templates

You can use work pools to organize work into groups. For example, you can create a work pool to classify work

that occurs in a specific warehouse location.

The Change work pool on work feature adds a Change work poolChange work pool  button to the Action Pane for work items.

Therefore, warehouse managers can easily change the work pool of existing work. This feature lets managers

react quickly to changes on the warehouse shop floor, and it helps improve their ability to adapt to changing

situations and the need to transfer work to another work pool.

Before you begin to set up or use this feature, you must make sure that it's available in your system. Admins can

use the feature management settings to check the status of the feature and turn it on if it's required. In the

Feature managementFeature management workspace, the feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Change work pool on work

To use this feature, you must have some work pools set up. You might also set up your work templates so that

they automatically assign a pool. If you want to work through the example scenario that is provided later in this

topic, set up your system as described in this section.

Work pools let you organize work items by type. To work with the Change work pool on work feature, you must

have at least two work pools available. To view and add work pools, follow these steps.

1. Go to Warehouse management > Setup > Work > Work poolsWarehouse management > Setup > Work > Work pools .

2. If you're working with demo data from the USMFUSMF company and will work through the example scenario

later in this topic, add two work pools that have the following settings:

Work pool 1:

Work pool ID:Work pool ID: Webshop

Descr iption:Descr iption: Web Shop

Work pool 2:

Work pool ID:Work pool ID: CallCenter

Descr iption:Descr iption: Call Center

3. On the Action Pane, select SaveSave.

For each of your work templates, you can set a default work pool, as you require. For each relevant template,

you assign a work pool in the Work pool IDWork pool ID column. In this case, all work items that are generated by using a

given template automatically inherit the assigned work pool. If you're working with the demo data from the

USMFUSMF company and will work through the example scenario later in this topic, follow these steps.

1. Go to Warehouse management > Setup > Work > Work templatesWarehouse management > Setup > Work > Work templates .

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/change-work-pool-on-work.md


Example scenario

Create a sales order and release it to the warehouseCreate a sales order and release it to the warehouse

2. On the Action Pane, select EditEdit to put the page into editing mode.

3. Edit the template by setting the following values:

Work template:Work template: 62 Pick to pack

Work pool ID:Work pool ID: Webshop

4. Select SaveSave.

This scenario shows how to change the stream of processing for an existing work item by changing its work

pool. It uses demo data from the USMFUSMF company and the settings that were suggested earlier in this topic.

1. Confirm that there is enough on-hand inventory for items A0001 and A0002 in warehouse 62. Go to

Inventor y management > Inquir ies and repor ts > On-hand listInventor y management > Inquir ies and repor ts > On-hand list, and edit the filters as shown

here:

The WarehouseWarehouse value begins with 62.

The Item numberItem number  value is either A001 or A002.

Demo data should have a quantity of 10 each.

Next, you must create a sales order.

2. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

3. On the Action Pane, select NewNew .

4. In the Create sales orderCreate sales order  dialog box, set the following values:

Customer account:Customer account: US-007

Warehouse:Warehouse: 62

5. Select OKOK to create the sales order and close the dialog box.

6. The new sales order is opened. It should include a new, empty line in the grid on the Sales order linesSales order lines

FastTab. On this line, set the following values:

Item number :Item number : A0001

Quantity:Quantity: 2

7. On the Inventor yInventor y  menu above the grid, select Reser vationReser vation.

8. On the Reser vationReser vation page, on the Action Pane, select Reser ve lotReser ve lot to reserve the inventory.

9. Close the page.

10. On the Sales order linesSales order lines  FastTab, select Add lineAdd line to add another line to your sales order. On this line,

set the following values:

Item number :Item number : A0002

Quantity:Quantity: 2

11. On the Inventor yInventor y  menu above the grid, select Reser vationReser vation.

12. On the Reser vationReser vation page, on the Action Pane, select Reser ve lotReser ve lot to reserve the inventory.

13. Close the page.

14. On the Action Pane, on the WarehouseWarehouse tab, select Release to warehouseRelease to warehouse.

15. You receive informational messages that show the wave ID and shipment ID that were created from the



Review the outbound waveReview the outbound wave

View work details and change the work poolView work details and change the work pool

IMPORTANTIMPORTANT

NOTENOTE

release. Make a note of the wave ID.

TIPTIP

1. Go to Warehouse management > Outbound waves > Shipment waves > All wavesWarehouse management > Outbound waves > Shipment waves > All waves .

2. In the grid, search for the wave ID that was created from the release of the sales order.

3. Select the wave ID to view the details.

4. On the Wave linesWave lines  FastTab, make sure that a shipment ID is shown for the sales order.

If the Process wave at release to warehouseProcess wave at release to warehouse option is set to No in the setup for the shipping wave template,

you must manually process the wave by selecting ProcessProcess from the WaveWave tab on the Action Pane to create work.

5. Make sure that the wave has been processed. This processing creates the required work.

You can use the Work detailsWork details  page to view the work that was created and to manage the work pool.

TIPTIP

1. Go to Warehouse management > Work > Work detailsWarehouse management > Work > Work details .

2. Select the row for the work that was just created. The Order numberOrder number  column will show the sales order

number.

The Work pool IDWork pool ID field will be set to the work pool ID that was set up in the work template.

If you don't see the Work pool IDWork pool ID field, add the column to the grid, and then refresh the page.

3. To change the work pool that is associated with the work ID, on the Action Pane, on the WorkWork tab, select

Change Work pool IDChange Work pool ID.

4. In the Change work poolChange work pool  dialog box, on the ParametersParameters  FastTab, in the Work pool IDWork pool ID field, select

CallCenter.

5. Select OKOK to apply your change.

6. Notice that the value of the Work pool IDWork pool ID field has now been changed to CallCenter.

When the Change work poolChange work pool dialog box appears, the Work pool IDWork pool ID field might be blank by default. If the field is blank

when you select OKOK to apply changes, you will remove the work pool completely from the work.

In addition to switching work pools, you can use this procedure to add a work pool to any work item that doesn't have

one, or to remove a work pool from any work item that does have one.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Turn on the features

Warehouse location status

Set up item consolidation and location utilization

This topic provides information about functionality that makes it easy for warehouse managers to view and filter

the volumetric utilization of locations across the warehouse. Managers can select locations and create inventory

movement work directly from the Item ConsolidationItem Consolidation page to consolidate items and therefore make better

use of warehouse space.

Before you can use the features that are described in this topic, you must turn them on in your system. Admins

can use the Feature management workspace to check the status of the features and turn them on if they are

required. Turn on both the following features, in the order that they are listed in. (Both features are for the

Warehouse managementWarehouse management module.)

1. Warehouse location status

2. Item consolidation location utilization

The Warehouse location status feature adds four new fields to the LocationsLocations  page to track additional

information about the current state of the location:

Item numberItem number  – The item that is currently in the location. If the location contains multiple items, this field

will be blank.

Last activity date and timeLast activity date and time – The timestamp of the last warehouse transaction that was performed

against the location.

Aging dateAging date – The date when the inventory in the location was brought into the warehouse. This date is

calculated based on the license plate aging date. Although this date is accurate for license plate–tracked

locations, it might not be accurate for locations that aren't license plate–tracked.

Location statusLocation status  – The status of the location. Four values are available:

UndeterminedUndetermined – The location profile doesn't track status. Therefore, the current status is unknown.

EmptyEmpty  – No inventory is currently in the location.

PickingPicking – Outbound transactions have been performed against the location after it was last empty.

StorageStorage – Only inbound transactions have been performed since the location was last empty.

These fields let warehouse managers get a better overview of the status of the locations in the warehouse. They

also allow for more advanced reporting and filtering.

This section describes how to prepare your system to use item consolidation and location utilization. The

procedures use sample values from the standard demo data. If you plan to work through the example scenario

that is provided later in this topic, select the USMFUSMF legal entity (which contains the standard demo data), and

create each record that is described in this section. If you don't plan to work through the example scenario, the

values that are provided here can be considered examples of the types of setup that you must complete to use

the features.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/item-consolidation-location-utilization.md


Released productReleased product

Location profileLocation profile

1. Go to Product information management > Products > Released productsProduct information management > Products > Released products .

2. In the Item numberItem number  field, select M9201, and open the details page.

3. On the Action Pane, on the Manage inventor yManage inventor y  tab, in the WarehouseWarehouse group, select PhysicalPhysical

dimensionsdimensions .

4. On the Physical dimensionPhysical dimension page, on the Action Pane, select NewNew .

A new line is added to the grid. The Item numberItem number  field is preset.

5. In the UnitUnit field, select ea. The remaining fields on the line are automatically set.

6. Select SaveSave, and close the page.

IMPORTANTIMPORTANT

TIPTIP

1. Go to Warehouse management > Setup > Warehouse > Location profilesWarehouse management > Setup > Warehouse > Location profiles .

2. In the list of location profiles, select FLOOR-05FLOOR-05 .

3. On the Action Pane, select EditEdit.

4. On the GeneralGeneral  FastTab, make sure that both the following options are set to Yes:

Enable item in location

Enable location status

5. Select SaveSave.

If the Enable item in locationEnable item in location and Enable location statusEnable location status options were already set to Yes, skip ahead to the

instructions for setting up the DimensionsDimensions FastTab in step 10. If the options weren't already set to Yes, you must

run a consistency check for the Warehouse managementWarehouse management  module after you manually set them. In this case,

continue to the next step.

6. To run the consistency check, go to System administration > Periodic tasks > Database >System administration > Periodic tasks > Database >

Consistency checkConsistency check .

7. In the Consistency checkConsistency check dialog box, set the following values:

Module:Module: Warehouse management

Check/Fix:Check/Fix: Check

From date:From date: Leave this field blank.

Warehouse location status consistency check :Warehouse location status consistency check : Select this check box.

8. Select OKOK.

When the consistency check is completed, you receive a notification. Open the Action Center to view the message.

Select Message detailsMessage details  to view the details.

If the message for the consistency check states, "Incorrect location status information found for location XXXX in

warehouse XX," you must run the consistency check again. This time, set the Check/FixCheck/Fix field to Fix error. View the

messages to make sure that no errors were found.

9. You must now finish setting up the location profile. Go back to Warehouse management > Setup >Warehouse management > Setup >



Mobile device menu itemsMobile device menu items

Mobile device menuMobile device menu

Movement typesMovement types

Example scenario

Warehouse > Location profilesWarehouse > Location profiles , select location profile FLOOR-05FLOOR-05 , and then, on the Action Pane,

select EditEdit.

10. On the DimensionsDimensions  FastTab, set the following values:

Volume utilization percentage:Volume utilization percentage: 100

Volumetr ic method used for inventor y location:Volumetr ic method used for inventor y location: Use location volume

Actual location height:Actual location height: 10

Actual location width:Actual location width: 10

Actual location depth:Actual location depth: 10

Maximum weight:Maximum weight: 100

11. Select SaveSave.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. On the Action Pane, select NewNew  to create a menu item for sorting.

3. In the header, set the following values:

Menu item name:Menu item name: Adjust In

Title:Title: Adjust In

Mode:Mode: Work

Use existing work :Use existing work : No

4. On the GeneralGeneral  FastTab, set the following values:

Work creation process:Work creation process: Adjustment in

Inventor y adjustment types:Inventor y adjustment types: Adjust in

5. Select SaveSave.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menuWarehouse management > Setup > Mobile device > Mobile device menu.

2. In the list of menus, select Inventor yInventor y .

3. On the Action Pane, select EditEdit.

4. In the Available Menus And Menu ItemsAvailable Menus And Menu Items list, find and select the Adjust InAdjust In menu item.

5. Select the right arrow button to move Adjust InAdjust In to the Menu StructureMenu Structure list. In this way, you add the new

menu item to the selected menu.

6. Select SaveSave.

1. Go to Warehouse management > Setup > Inventor y > Movement typesWarehouse management > Setup > Inventor y > Movement types .

2. On the Action Pane, select NewNew , and then set the following values:

Movement type code:Movement type code: CONSOLIDATE

Descr iption:Descr iption: Consolidate locations

Work class ID:Work class ID: InvMov

3. Select SaveSave.

The following scenario uses the warehouse app on a mobile device to make an inventory adjustment in to two

locations in the warehouse.



Add inventory to locationsAdd inventory to locations

Consolidate locationsConsolidate locations

1. Sign in to the mobile device as a user who is set up for warehouse 51.

2. Go to Inventor y > Adjust InInventor y > Adjust In .

You will now enter the first location adjustment.

3. In the Adjustment inAdjustment in task, select the location to make the inventory adjustment for. In the LOCLOC field,

select LP-001.

4. Confirm the location.

5. Create a license plate ID for the item that will be added to the location. In the LPLP field, enter LP00101.

6. Confirm the license plate.

7. Enter the item that will be added to the license plate. In the ITEMITEM field, enter M9201.

8. Confirm the item.

9. Enter the quantity of the item that will be added. In the QTYQTY field, enter 10.

10. Confirm the quantity.

You receive a "Work Completed" message. You will now enter the second location adjustment.

11. In the Adjustment inAdjustment in task, select the location to make the inventory adjustment for. In the LOCLOC field,

select LP-002.

12. Confirm the location.

13. Create a license plate ID for the item that will be added to the location. In the LPLP field, enter LP00201.

14. Confirm the license plate.

15. Enter the item that will be added to the license plate. In the ITEMITEM field, enter M9201.

16. Confirm the item.

17. Enter the quantity of the item that will be added. In the QTYQTY field, enter 15.

18. Confirm the quantity.

You receive a "Work Completed" message.

19. Select the Menu button (sometimes referred to as the hamburger or the hamburger button), and then

select CancelCancel  to exit the Adjustment inAdjustment in task.

1. Go to Warehouse management > Periodic tasks > Item consolidationWarehouse management > Periodic tasks > Item consolidation.

2. In the header, select a warehouse to do the consolidation for. In the WarehouseWarehouse field, enter 51.

A record is shown for each location where item M9201 was adjusted. The Utilization percentageUtilization percentage

column shows the volumetric utilization of each location.

3. To consolidate inventory, select all the locations that must be consolidated, and then, on the Action Pane,

select Consolidate Inventor yConsolidate Inventor y .

4. In the Consolidate inventor yConsolidate inventor y  dialog box, specify the location and movement type that should be used

to create the work for inventory movement. Set the following values:

Location:Location: LP-001



View movement workView movement work

NOTENOTE

Movement type code:Movement type code: CONSOLIDATE

5. Select OKOK.

6. You receive an informational message that shows the movement work that was created. Make a note of

the movement work ID.

NOTENOTE

1. Go to Warehouse management > Work > Work detailsWarehouse management > Work > Work details .

2. View the work that was created. Use the movement work ID from the inventory consolidation to filter or

search the work grid.

In this scenario, an existing location that had inventory was used as the inventory consolidation location.

Therefore, only one work ID was created.

The system creates one work ID for each move that must be completed. If you specify a location that already

contains inventory, only one work ID is created. If you specify a new location, two work IDs are created.

Can you tell us about your documentation language preferences? Take a short survey.
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I can't move license plates that have serial number items when blank
issue and blank receipt are allowed on the tracking dimension group.
Issue descriptionIssue description

Issue resolutionIssue resolution

I receive the following error message in the warehouse app when I
process movements: "The inventory owner %1 is not allowed in this
process."
Issue descriptionIssue description

Issue resolutionIssue resolution

NOTENOTE

This topic describes how to fix common issues that you might encounter while you work with warehouse work

in Microsoft Dynamics 365 Supply Chain Management.

You can't move a license plate by using a MovementMovement menu item if the serial number has settings of Blank issue

allowed and Blank receipt allowed on the tracking dimension group, and if there are multiple license plates in

the same location, some of which have serial numbers and some of which don't have them.

This issue will be fixed by changes that are deployed in KB 4571546. Those changes will make the Ser ialSer ial

numbernumber  field optional when blank receipt and blank issue are allowed.

The OwnerOwner  tracking dimension is missing when the warehouse app is used to make movements. A regular

inventory transfer journal from the Supply Chain Management client appears to work as intended and can be

posted only if the OwnerOwner  dimension is filled in.

Microsoft has evaluated this issue and has determined that it's a feature limitation. Currently, warehouse

management processes support only inventory that is owned by the legal entity.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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IMPORTANTIMPORTANT

Turn on the work split functionality

NOTENOTE

Enhancements to the Work details and All work pages

Work split functionality lets you split large work IDs (that is, work orders that have several lines) into several

smaller work IDs that you can then assign to multiple warehouse workers. In this way, the same work creation

number can be picked simultaneously by several warehouse workers.

You can split only work orders that have a status of Open or In-progress.

Before you can use the work split functionality, you must turn on the feature and its prerequisite feature in your

system. Administrators can use the feature management settings to check the status of the features and turn

them on as required.

First, turn on the prerequisite Organization-wide work blocking feature if it isn't already turned on. In the

Feature managementFeature management workspace, this feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Organization-wide work blocking

When this feature is activated, a data upgrade is automatically applied after the feature is turned on across all legal

entities.

Next, turn on the Work split feature, which is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Work split

The Work split feature adds the following two buttons to the WorkWork tab on the Action Pane of the Work detailsWork details

and All workAll work pages:

Split workSplit work – Split the current work ID into multiple smaller work IDs that can be processed by separate

workers.

Cancel work split sessionCancel work split session – Cancel the work split session, and make the work available for processing.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/work-split.md


IMPORTANTIMPORTANT

Initiate a work split

The Split workSplit work button won't be available if any of the following conditions are met:

The work status is something other than Open or In progress.

A container ID is associated with the work ID. (A container can't be systematically split, because it requires physical

actions.)

The work is associated with a cluster.

The work order type is something other than one of the following types:

Sales orders

Raw material picking

Transfer issue

The work is currently being split by another user. If you try to open the splitting page for work that is already

being split by another user, you receive the following error message: "The work with ID #### is currently being

split. Retry in a few minutes. If you continue to receive this message, contact a supervisor."

A new work blocking reason, Split work, indicates when the work ID is in the process of being split. It's shown

both on the Split workSplit work page and in the warehouse app if a user tries to run the work. When blocking reasons

are used, the name of the Blocked waveBlocked wave field from the work ID is changed to BlockedBlocked.

The feature adds a new Split workSplit work page that lets users split work lines from the work ID. When the page is first

opened, it shows lines that have a work status of Open and that are available to be split. On the Action Pane,

select Split workSplit work to process the selected work.

To split work, follow these steps.

1. Open one of the following work pages:

Work detailsWork details  (Warehouse management > Work > Work detailsWarehouse management > Work > Work details )

All workAll work (Warehouse management > Work > All workWarehouse management > Work > All work)

2. In the grid, select a work ID to split. The Work order typeWork order type field must be set to one of the following

values:

Sales orders

Raw material picking

Transfer issue

3. On the Action Pane, on the WorkWork tab, in the WorkWork group, select Split workSplit work .

The Split workSplit work page appears and shows the work lines that are open and available to be split. By default,

only available work lines are shown. To view all lines for the work ID (for example, lines that have a work

type of Put), select the Show all l inesShow all l ines  check box above the grid.

The following message is shown: "Users can't process lines of the work until you finish splitting and close

this page."

The Work blocking reasonWork blocking reason field for the current work will be set to Split work, and the work will be

blocked.



4. Select the lines to remove from the current work ID and add to a new work ID. The following events

occur :

When you split the work, the selected line or lines from the original work ID are canceled and then

copied to a new work ID.

The existing work template structure and the location of the put (and also future pick/put pairs) are

preserved. Values for the following work ID fields are copied from the original work to the new

work:

Load ID

Shipment ID

Work order type

Order number

Site

Warehouse

Work priority

Work pool ID

Wave ID

Work creation number

The following fields aren't copied to the new work ID:

Work IDWork ID – A new work ID is generated from the appropriate number sequence.

Work statusWork status  – This field is set to Open.

Locked byLocked by  – This field is initially set to blank.

Target license plate IDTarget license plate ID – This field is left blank.

Created date and timeCreated date and time – This field is set to the current date and time.

Blocked wave/frozenBlocked wave/frozen – This field is recomputed for the original work ID and the new work ID.

5. On the Action Pane, select Split workSplit work .

While the work is being split, the following message is shown: "Processing operation - Split work". While this

message is visible, you can cancel the operation by selecting CancelCancel  in the message box.

If the Show all l inesShow all l ines  check box is cleared, the line that was split off and canceled will no longer appear in the

grid. If the check box is selected, you should see that the value of the Work statusWork status  field for that line has

changed to Canceled.

The following notification is shown to indicate that the new work ID has been created: "Work #### has been

created by splitting off from original work ####."

Other work lines from the original work ID (such as Put lines) will be adjusted as required to reflect the lines of

work that have been canceled. For example, if the original work ID had a Put line for a quantity of 15, and Pick

lines that have a total quantity of 10 were canceled, the new Put quantity on the original work ID will now be 5.

The new work won't immediately be assigned to any user. However, you can assign it to a user now, as required,

by using the standard functionality of the Work detailsWork details  page.



IMPORTANTIMPORTANT

Finish a work split

User blocking on the warehouse app

Other blocked operations

NOTENOTE

You can split only work IDs that contain two or more available work lines. If you select Split workSplit work when there is only one

work line, you will receive the following error message: "At least one work line must remain on initial work." In this case,

no splitting will occur.

To finish splitting work, the Split work blocking reason must be removed. There are two ways to complete this

step:

The user who is splitting the work closes the Split workSplit work page by selecting the CloseClose button (XX) in the upper-

right corner. When the page is closed, the Split Work blocking reason will be removed. The Blocked state of

this work will be recomputed and, if there are no remaining blocking reasons for this work, the work will be

unblocked.

Any user opens the work ID and selects the Cancel work split sessionCancel work split session button on the Action Pane. The Split

work blocking reason will be removed, and the Blocked state of this work will be recomputed, just as when

the Split workSplit work page is closed.

After the Split work blocking reason is removed, the work can be run on the mobile device, provided that the

BlockedBlocked state is set to No on the work ID.

If you try to use the warehouse app to run picking work against a work ID that is being split, you will receive the

following error message: "The work with ID #### is currently being split." If you receive this message, select

CancelCancel . You can then continue to process other work.

Any operations that modify work lines, work inventory transactions, or replenishment links that are related to

work that is being split will fail, and the following error message will be shown: "The work with ID #### is

currently being split."

Can you tell us about your documentation language preferences? Take a short survey.
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Warehouse layout

Zone groups, zones, location types, and locationsZone groups, zones, location types, and locations

This article explains how to configure a warehouse. It includes information about how to enable a warehouse

layout and warehouse processes.

This article applies to features in the Warehouse managementWarehouse management  module (advanced warehousing). It doesn't apply to

warehouse features in the Inventor y managementInventor y management  module.

The Warehouse management system in Supply Chain Management gives you flexible ways to define your

warehouse layout to meet changing needs, so that you can achieve optimal warehouse efficiency.

You can establish high-priority and low-priority storages areas for optimum placement of goods.

You can divide your warehouse into zones to accommodate various storage needs, such as temperature

requirements, or various turnover rates for items.

You can specify warehouse locations on any level (for example, site, warehouse, aisle, rack, shelf, and bin

position).

You can group locations by using physical capacity constraint settings.

You can control how items are stored and picked, based on query-defined rules.

To use warehouse management in Supply Chain Management, you must create a warehouse and enable it for

more advanced or specialized warehouse management activities. On the WarehousesWarehouses  page, select the UseUse

warehouse management processeswarehouse management processes  option.

As part of the process for enabling a warehouse layout, you must define warehouse zone groups, and zones,

location profiles, location types, and locations.

Zone groupsZone groups  – A logical or physical grouping of zones within a warehouse.

ZonesZones  – A logical or physical grouping of locations within a warehouse.

Location profilesLocation profiles  – A logical or physical grouping of locations that have the same warehouse location

process policies (for example, a mix of different item numbers can be stored there, and the same physical

capacity constraints apply).

Locations typesLocations types  – A logical or physical grouping of the warehouse locations. For example, you can create a

location type for all staging locations. Mandatory settings on the Warehouse management parametersWarehouse management parameters

page drive the process of defining staging location types and the final shipping location type.

LocationsLocations  – The lowest level of location information. Locations are used to track where the on-hand

inventory is stored and picked in a warehouse.

The entities that you create to define your warehouse layout are used in the queries that you set up in work

templates to drive work orders in the warehouse. Therefore, when you define the zones, location types, and so

on, consider how different areas in the warehouse are used for different processes. Additionally, consider factors

such as the physical characteristics of a particular area. For example, there might be areas where you can use

only a certain type of forklift truck. Or, if your company has both production and finished goods within the same

facility, you might want to create a single warehouse in Supply Chain Management but then separate the two

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/warehouse-configuration.md


Location stocking limits, location profiles, and fixed picking locationsLocation stocking limits, location profiles, and fixed picking locations

Location setup wizardLocation setup wizard

Warehouse processes

Wave templatesWave templates

Work templatesWork templates

operations by creating two zone groups. Give your entities descriptive names, so that it's easy to identify them

when you use them in template queries.

You must consider the physical layout of the warehouse, both to determine storage capacities (location stocking

limits and location profiles) and as part of your attempts to achieve optimal warehouse processes.

Location stocking limits help guarantee that work isn't created to request that inventory be put in a location that

doesn't have the physical capacity to carry the inventory. For example, if some locations within a warehouse can

hold only one pallet per location, location stocking limits can be enabled. The QuantityQuantity  value can be set to 11 ,

and the UnitUnit value can be set to PLPL  within a specific location profile grouping.

If more advanced calculations are required to control the location capacity constraints, the location profile

settings can be used. In this case, the weight and volume are considered when capacity calculations are done.

To achieve optimal outbound processes, you should evaluate whether to use fixed picking locations and/or

packing locations. Often, minimum/maximum replenishment is used for replenishment processes from a bulk

area to the fixed picking locations, and multiple fixed picking locations can be enabled within the same

warehouse and for product variants. Consider the flexibility that can you achieve by enabling dedicated demand

replenishment overflow locations that are used only for wave/load replenishment processing.

To quickly create the locations within a warehouse, you can use the Location setupLocation setup wizard. As part of this

process, you can easily maintain the format of the location names.

As part of the configuration of the warehouse, it's important that you enable warehouse processes according to

business requirements. The most important components that you must configure are wave templates, work

templates, work pools, and location directives.

Wave templates help enable the outbound "Release to warehouse" process. As soon as order lines are released

(either directly from source documents, via batch job processes, or via loads that have already been created), the

wave template functionality is used.

You can create three types of wave templates:

ShippingShipping

Production orderProduction order

KanbanKanban

Parameters are used to define how far the system should automatically go in the outbound work processing. A

wave template is selected based on the wave template sequence and criteria that are specified in the template. If

a template is listed at the top of the sequence, the criteria in that template are checked first. If the criteria can be

met, the wave template is processed. Otherwise, the criteria in the next template are checked, and so on.

Therefore, it's a good idea to put the template that has the most specific criteria at the top of the wave template

sequence list, so that it's processed first. For example, you want to process all the work for a specific carrier

today and temporarily delay processing of the work for other carriers. In this case, the wave template that

selects work for that carrier should be listed higher in the sequence than other templates. Otherwise, the work

for other carriers might be processed before the work for that carrier is completed.

You must specify the wave process methods in each wave template. The methods that are available vary,

depending on the wave template type.



Work poolsWork pools

Location directivesLocation directives

Additional resources

NOTENOTE

Work template definitions play an important role in the definition of warehouse management work processes.

They define what work is performed, and how the work is done. Templates can also contain a directive code that

links to a location directive to determine where work is performed. Work templates include a query that

specifies the criteria for the work. Each template must include at least one Pick operation and one Put operation

to drive the basic work operation of transferring on-hand inventory from one location to another.

If multiple workers must be able to process work for some of your warehouse operations, you might want to

use the concept of staging for the inventory and separate the work execution into different work classes.

Work pools are used to organize work into groups. For example, you can create a work pool to classify work that

occurs in a particular warehouse location. For all work types except counting, you can assign a work pool to a

work template. For cycle counting, you can assign a work pool on the following pages:

Cycle count plans

Cycle count thresholds

Cycle count work by location

Cycle count work by item

When you use work templates to create work, the work pool is automatically assigned to the work.

Work pool IDs can also be used to limit the type of work that is directed to a particular warehouse worker,

provided that this functionality is configured on the relevant mobile device menu item.

As the name suggests, location directives are used to direct the work transactions to the appropriate locations in

the warehouse. In other words, they define where to pick and put.

To make it easier and quicker to define the actions that are associated with each location directive line, use one

of the predefined strategies. For example, you can use the Empty location with no incoming workEmpty location with no incoming work strategy

to search for free locations in a warehouse, or you can use FEFO batch reser vationFEFO batch reser vation strategy for outbound

sales picking.

Configure locations in a WMS-enabled warehouse
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Scenarios where configuration templates can be helpful

Copy a configuration setup from a test environment to a production
environment

NOTENOTE

Export a default warehouse templateExport a default warehouse template

This topic explains how to set up a warehouse by using a warehouse configuration template. There are several

predefined configuration templates that you can use. For information about how to use these templates, see

Configuration data templates.

Configuration templates can be helpful in many scenarios. Here are some examples:

You've completed and tested a configuration setup in a test environment, and you now want to copy the

setup to a production environment.

You want to roll the warehouse setup out to several legal entities or create a new warehouse in the same

legal entity.

You want to quickly prepare for a demo of the warehouse functionality.

You want existing items and warehouses to use the functionality in Warehouse management instead of the

functionality in Inventory management.

This topic focuses on the first of these scenarios. It shows how you can use a configuration template to copy a

configuration setup from a test environment to a production environment.

For this scenario, the configuration setup for a warehouse and some transaction processes already exist in a test

environment. You now want to copy the configuration setup for the warehouse from the test environment to a

production environment.

It's important that you include other related setup data when you copy a configuration setup. For example, you want to

set up products by copying the setup from a test environment. However, you can't set up a fixed picking location for a

product before that product is created. Although individual configuration templates don't support this type of

dependency, there are default data templates that support it. You can easily include these default data templates in a

configuration process.

NOTENOTE

1. Open the Data managementData management workspace.

If you're using this workspace for the first time, you must load all the data entities before you continue.

2. Select the TemplatesTemplates  tile, and then select Load default templatesLoad default templates  to load the default templates.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/inventory/warehouse-template.md
file:///T:/eiye/ac1a/dynamics365/dev-itpro/data-entities/configuration-data-templates.html
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Load default templatesLoad default templates is available only in the EnhancedEnhanced view. Select Framework parametersFramework parameters , and then, in

the View defaultsView defaults  field, select Enhanced viewEnhanced view.

3. After the default templates are loaded, you can change them so that they meet your business

requirements.

To load default templates and import templates, you must have system administrator access. This requirement

helps guarantee that all entities are correctly loaded into the template.

4. Make sure that you're in the legal entity that you want to export the company-specific data from.

5. In the workspace, select Expor tExpor t.

6. Create a new export project.

7. Select + Add template+ Add template, and find the 400 - WMS400 - WMS  default warehouse template. This template adds data

entities for warehouse configuration.

If the data that you're exporting must be filtered (for example, you want to export only the data that is related to

a specific warehouse), you must evaluate each data entity and add filtering via a query. Alternatively, you can

export all data and then delete the records that aren't required in the destination files.

8. Select Expor tExpor t. Data that is related to all the data entities in the project is exported.

You can download a zip file for the data package. This file contains all the data in the selected format (for

example, Excel format). As has been mentioned, some records in the data package files might have to be

updated before you can import them into the production environment. If you update a record, make sure that

you don't change the file name.

NOTENOTE

1. In the destination environment, make sure that you're in the company that you want to import the

warehouse data into.

Before you do the import, you should identify any data dependencies. For example, the WarehouseWarehouse

managementmanagement  template includes a data entity that is named Warehouse disposition codesWarehouse disposition codes . This entity

contains data that is related to the Disposition codesDisposition codes setup page (Warehouse managementWarehouse management  > SetupSetup >

Mobile deviceMobile device > Disposition codesDisposition codes). If an existing setup already handles the return process for sales orders,

the Return disposition codeReturn disposition code field contains a value. The disposition code in this field is related to the

Disposition codeDisposition code data entity, which is part of the Sales and marketingSales and marketing template. If the data from the

Disposition codeDisposition code data entity isn't imported before the data from the Warehouse disposition codesWarehouse disposition codes field, the

import will fail.

2. In the Data managementData management workspace, select Impor tImpor t.

3. Create a new import project.

4. Select + Add file+ Add file, and upload the zip file for the data package.
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5. Select Impor tImpor t. In the EnhancedEnhanced view, you can use the FilterFilter  option to quickly get an overview of issues

that might occur during the import.

The View executionView execution log provides detailed information about each data entity that is imported. You can use the

staging data view to quickly get to the target data. In this way, you can see what the imported data looks like on

the related pages in the application. When you use the default data templates, the import sequence for each

data entity works in the predefined manner, to help guarantee that all dependent data is imported first. If custom

data entities are part of the project, you must make sure that the correct sequence is defined. For more

information, see Configuration data templates.

To learn more about how to use warehouse template to copy the configuration of a warehouse from one

company to a new company within the same instance, see this 3-minute video on YouTube about how to use

warehouse template to copy the configuration for Finance and Operations.

Configuration data templates

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

file:///T:/eiye/ac1a/dynamics365/dev-itpro/data-entities/configuration-data-templates.html
https://www.youtube.com/watch?v=K2WIfFlqJYs
file:///T:/eiye/ac1a/dynamics365/dev-itpro/data-entities/configuration-data-templates.html
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Work templates

This topic describes how to use work templates and location directives to determine how and where work is

carried out in the warehouse.

The instructions that warehouse workers receive on a mobile device are determined by the Dynamics 365

Supply Chain Management work templates that you set up to define the various warehouse processes and

tasks. Work templates determine how the work is performed for each warehouse process. By linking a location

directive to work templates, you can help guarantee that work occurs in specific physical areas of the

warehouses.

The Work templatesWork templates  page lets you define the work operations that must be performed in the warehouse.

Typically, warehouse work operations consist of a pair of actions: a warehouse worker picks up on-hand

inventory in one location and then puts the picked inventory down in another location.

Work templates consists of a header and associated lines. Each work template is for a specific work order type.

Many work order types are associated with source documents, such as purchase or sales orders. However, other

work order types represent separate warehouse processes, such as cycle counting. The work pool ID lets you

organize work into groups.

Use the settings in the work header definition to determine when a new piece of work should be created. For

example, you can set a maximum number of pick lines and a maximum expected pick time. Then, if the work for

a sales order picking process exceeds either of those values, that work is split into two pieces of work.

Use the Work header breaksWork header breaks  button to define when the system should create new work headers. For example,

to create a work header for each order number, select Edit quer yEdit quer y  on the Action Pane, and then add the OrderOrder

numbernumber  field to the Sor tingSor ting tab of the query editor. Fields that are added to the Sor tingSor ting tab are available for

selection as grouping fields. To set your grouping fields, select Work header breaksWork header breaks  on the Action Pane, and

then, for each field that you want to use as a grouping field, select the check box in the Group by this fieldGroup by this field

column.

The work lines represent the physical tasks that are required to process the work. For example, for an outbound

warehouse process, there might be one line for picking up the items in the warehouse and another line for

putting those items into a staging area. There can then be an additional line for picking the items from staging

and another line for putting the items into a truck as part of the loading process. You can set a directive code on

work template lines. A directive code is linked to a location directive, and therefore helps ensure that the

warehouse work is processed in the correct location in the warehouse.

You can set up a query to control when a particular work template is used. For example, you can set a limitation

so that a particular template can be used for work only in a specific warehouse. Alternatively, you might have

several templates that create work for outbound sales order processing, depending on the sales origin. The

system uses the Sequence numberSequence number  field to determine the order that the available work templates are assessed

in. Therefore, if you have a very specific query for a particular work template, you should give it a low sequence

number. That query will then be evaluated before the other, more general queries.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/control-warehouse-location-directives.md
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To prevent the system from automatically overwriting work template sequence numbers after a template has been

deleted, turn on the Preserve work template sequence numbers on delete feature in Feature management.

To stop or pause a work process, you can use the Stop workStop work setting on the work line. In that case, the worker

who is performing the work won't be asked to perform the next work line step. To move on to the next step, that

worker or another worker must select the work again. You can also separate the tasks within a piece of work by

using a different work class ID on the work template lines.

Location directives are rules that help identify pick and put locations for inventory movement. For example, in a

sales order transaction, a location directive determines where the items will be picked, and where the picked

items will be put. Location directives consist of a header and associated lines, and you create them on the

Location directivesLocation directives  page.

On the header, each location directive must be associated with a work order type that specifies the type of

inventory transaction that the directive will be used for, such as sales orders, replenishment, or raw material

picking. The work type specifies whether the location directive will be used for picking or putting work, or for

some other warehouse process, such as counting or inventory status changes. You must also specify a site and a

warehouse. A directive code that you specify on the header can be used to link the location directive to one or

more work templates.

As for work templates, you can set up a query to determine when a particular location directive is used. For

example, you can specify that when e-commerce is the origin of a sales order, the inventory must be picked up

from a dedicated area in the warehouse. The system uses the Sequence numberSequence number  field to determine the order

that the available location directives are assessed in.

The location directive lines set additional restrictions on the application of the location finding rules. You can

specify a minimum quantity and a maximum quantity that the directive should apply to, and you can specify that

the directive should be for a specific inventory unit. For example, if the unit of measure is pallets, the items in

pallets can be put in a specific location. You can also specify whether the quantity can be split across multiple

locations. Like the location directive header, each location directive line has a sequence number that determines

the order that the lines are assessed in.

Location directives have one additional level of detail: location directive actions. You can define multiple location

directive actions for each line. Once again, a sequence number is used to determine the order that the actions

are assessed in. On this level, you can set up a query to define how to find the best location in the warehouse.

You can also use predefined StrategyStrategy  settings to find an optimal location.

For more information about how to create and configure location directives, see Create a location directive.

Location directives determine where items should be picked and where they should be put. The system

evaluates a location directive against each work line and then selects a location, based on the work line details.

The system first finds all location directives that match a particular work line (for example, they are for the

correct warehouse and match the query). It then sequentially evaluates the directives that it has found.
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Additional resources

NOTENOTE

There are special cases where the pick location or put location is pre-selected. For example, during purchase registration,

the first pick is always from the location where the registration occurs. Another example is inventory movement by

template, where the warehouse worker selects the pick location, and only the put locations are found through location

directives.

Video: Warehouse management configuration deep dive

Help topic: Create location directives

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://community.dynamics.com/365/b/techtalks/posts/warehouse-management-configuration-deep-dive-october-14-2020
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Prerequisites

Work order types for location directives

Location directives are rules that help identify pick and put locations for inventory movement. For example, in a

sales order transaction, a location directive determines where the items will be picked, and where the picked

items will be put. Location directives consist of a header and associated lines. They are created for specific work

order types.

This topic applies to features in the Warehouse managementWarehouse management  module. It doesn't apply to features in the Inventory

management module.

You can use location directives to perform the following tasks:

Put away incoming items.

Pick and stage items for outbound transactions.

Pick and put raw materials for production.

Replenish locations.

Before you can create a location directive, you must follow these steps to make sure that the prerequisites are in

place.

1. Make sure that the required license key is turned on. Go to System administration > Setup > L icenseSystem administration > Setup > L icense

configurationconfiguration, expand the TradeTrade license key, and then select the Warehouse and Transpor tationWarehouse and Transpor tation

managementmanagement configuration key. Note that admin access is required for this step.

2. Go to Warehouse management > Setup > Warehouse > WarehousesWarehouse management > Setup > Warehouse > Warehouses .

3. Create a warehouse.

4. On the WarehouseWarehouse FastTab, set the Use warehouse management processesUse warehouse management processes  option to Yes.

5. Create locations, location types, location profiles, and location formats. For more information, see Configure

locations in a WMS-enabled warehouse.

6. Create sites, zones, and zone groups. For more information, see Warehouse set up and Configure locations in

a WMS-enabled warehouse.

Many of the fields that can be set for location directives are common to all work order types. However, other

fields are specific to particular work order types.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/create-location-directive.md
https://docs.microsoft.com/en-us/dynamics365/supply-chain/warehousing/tasks/configure-locations-wms-enabled-warehouse
https://docs.microsoft.com/en-us/dynamics365/commerce/channels-setup-warehouse
https://docs.microsoft.com/en-us/dynamics365/supply-chain/warehousing/tasks/configure-locations-wms-enabled-warehouse
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Fields that are common to all work order typesFields that are common to all work order types
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Location directives Work type

Location directives Site

Location directives Warehouse

Location directives Directive code

Location directives Multiple SKU

Lines Sequence number

Lines From quantity

Lines To quantity

Lines Unit

Lines Locate quantity

Lines Restrict by unit

Lines Round up to unit

Lines Locate packing quantity

Two work order types, Canceled work and Cycle counting, are used only by the system. Location directives can't be

created for these work order types.

The tables in the following subsections list the common and worker order type–specific fields that are available

when you set up a location directive.

The following table lists the fields that are common to all work order types.



        

Lines Allow split

Location Directive Actions Sequence number

Location Directive Actions Name

Location Directive Actions Fixed location usage

Location Directive Actions Allow negative inventory

Location Directive Actions Batch enabled

Location Directive Actions Strategy
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Fields that are specific to work order typesFields that are specific to work order types
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Location directives Locate by Purchase orders

Location directives Applicable disposition code Purchase orders

Location directives Disposition code Purchase orders

Location directives Applicable disposition code Finished goods put away

Location directives Disposition code Finished goods put away

Location directives Applicable disposition code Return orders

Location directives Disposition code Return orders

Location directives Applicable disposition code Kanban put away

Location directives Applicable disposition code Kanban picking

Lines Immediate replenishment template Sales orders

Lines Immediate replenishment template Raw material picking

Lines Immediate replenishment template Transfer issue

Lines Immediate replenishment template Kanban picking

Open the Location directives page

The following table lists the fields that are specific to particular work order types.

To open the Location directivesLocation directives  page, go to Warehouse management > Setup > Location directivesWarehouse management > Setup > Location directives .

From there, you can view, create, and edit your location directives by using the commands on the Action Pane.

See the remaining sections of this topic for information about how to use all the fields that are available on the



Action Pane

Location directives header

Location directives FastTab

page.

The Action Pane on the Location directivesLocation directives  page contains buttons that you can use to create, edit, and delete

directives (EditEdit, NewNew , and DeleteDelete). It also contains the following buttons that let you adjust the sequence that

the location directive is processed in and configure a query that defines the criteria for applying the location

directive:

Move upMove up – Move the selected location directive up in the sequence. For example, you can move it from

sequence number 4 to sequence number 3.

Move downMove down – Move the selected location directive down in the sequence. For example, you can move it

from sequence number 4 to sequence number 5.

Edit quer yEdit quer y  – Open a dialog box where you can define the conditions that the selected location directive

should be processed under. For example, you might want it to apply only to a specific warehouse.

The location directive header includes the following fields for the sequence number and descriptive name of the

location directive:

Sequence numberSequence number  – This field indicates the sequence that the system tries to apply each location directive

in for the selected work order type. Low numbers are applied first. You can change the sequence by using the

Move UpMove Up and Move DownMove Down buttons on the Action Pane.

NameName – Enter a descriptive name for the location directive. This name should help identify the general

purpose of the directive. For example, enter Sales order picking in warehouse 24.

The fields on the Location directivesLocation directives  FastTab are specific to the work order type that is selected in the WorkWork

order typeorder type field in the list pane.

IMPORTANTIMPORTANT

Work typeWork type – Select the type of work that must be performed. The available values depend on the type of

inventory transaction that you selected in the Work order typeWork order type field. Select one of the following values:

PutPut – The location directive will try to find the most ideal location to put or locate inventory that

comes into the system from receiving, production, or inventory adjustments. It can also be used to

define the put to the stage location or the final bay door shipping location.

PickPick – The location directive will try to find the most ideal locations to physically reserve inventory

from (that is, create work). The pick can be completed (that is, the pick work line can be closed) even if

the work isn't completed. The user can complete physical picking. In the system, that action is a pick

step. The user can then cancel from the mobile device and complete the work later. However, the work

header is first closed when the final put is completed.

The other values in the Work typeWork type field aren't relevant for location directives. They appear only because the field

isn't filtered to match the selected work order type.

SiteSite – This field is mandatory, because the location directive must be able to determine the site and

warehouse that it's valid for.

WarehouseWarehouse – This field is mandatory, because the location directive must be able to determine the site

and warehouse that it's valid for.
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Directive codeDirective code – Select the directive code to associate with a work template or replenishment template.

On the Directive codeDirective code page, you can create new codes that can be used to connect work templates or

replenishment templates to location directives. Directive codes can also be used to establish a link

between any work template line and a location directive (such as the bay door or stage location).

If a directive code is set, the system won't search location directives by sequence number when work must be

generated. Instead, it will search by directive code. In this way, you can be more specific about the location

template that is used for a particular step in a work template, such as the step for staging the materials.

Multiple SKUMultiple SKU – Set this option to Yes to enable multiple stockkeeping units (SKUs) to be used on a

location. For example, multiple SKUs must be enabled for the bay door location. If you enable multiple

SKUs, your put location will be specified in work, as expected. However, the put location will be able to

handle only a multi-item put (if work includes different SKUs that must be picked and put). It won't be

able to handle a single-SKU put. If you set this option to No, your put location will be specified only if

your put has just one kind of SKU.

To be able to do both multi-item puts and single-SKU puts, you must specify two lines that have same structure

and setup, but you must set the Multiple SKUMultiple SKU option to Yes for one line and No for the other. Therefore, for put

operations, you must have two identical location directives, even if you don't have to distinguish single SKUs and

multiple SKUs on a work ID. Often, if you don't set up both these location directives, unexpected business process

locations will come from the applied Location directive. You must use a similar setup for location directives that

have a Work typeWork type of pick if you need to process orders that include multiple SKUs.

Use the Multiple SKUMultiple SKU option for work lines that handle more than one item number. (The item number

will be blank in the work details, and it will be shown as MultipleMultiple on the processing pages in the

warehouse app.)

In a typical example scenario, a work template is set up so that it has more than one pick/put pair. In this

case, you might want to search for a specific staging location to use for lines with a Work typeWork type of Put.

If the Multiple SKUMultiple SKU option is set to Yes, you can't select Edit quer yEdit quer y  on the Action Pane, because the query can't

evaluate at the item level when there are multiple items. To ensure that the desired location directive is selected,

use the Directive codeDirective code field to guide the selection of the location directive that is related to the put lines where

that directive code is assigned in the work template.

Unless you always work with either single-item or mixed-item operations, it's important that you define

two location directives for the Put work type: one where the Multiple SKUMultiple SKU option is set to Yes and one

where it's set to No.

Applicable disposition codeApplicable disposition code – Specify whether the disposition code of the location directive must

match the disposition code that is applied when the item is received, or whether the location directive can

be selected based on any disposition code. If you select Exact match, and the Disposition codeDisposition code field is

blank, only blank disposition codes will be considered for this location directive.
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This field is available only for selected work order types where replenishment is permitted. For a complete list, see

the Fields that are specific to work order types section earlier in this topic.

Locate byLocate by  – Specify whether the putaway quantity should be the whole quantity on the license plate, or

whether it should be item by item. Use this field to help ensure that all the contents on a license plate is

put into one location, and that the system doesn't suggest that you split the contents into several

locations for ASNASN (license plate receiving), Mixed license plateMixed license plate receiving, and ClusterCluster  receiving

processes. (The ClusterCluster  receiving process requires that the Cluster putaway feature feature be turned

on.) The behavior of the location directive query, the lines, and the location directive actions will vary,

depending on the value that you select. The L inesLines  FastTab is only used when the Locate byLocate by  is set to Item.

This field is available only for selected work order types where replenishment is permitted. For a complete list, see

the Fields that are specific to work order types section.

Disposition codeDisposition code – This field is used for location directives that have a work order type of Purchase

orders, Finished goods putaway, or Return orders, and a work type of Put. Use it to guide the flow to use

a specific location directive, depending on the disposition code that a worker selected in the warehouse

app. For example, you can direct returned goods to an inspection location before they are returned to

stock. A disposition code can be linked to an inventory status. In this way, it can be used to change the

inventory status as part of a receiving process. For example, you have a disposition code, QA, that sets

the inventory status to QA. You can then have a separate location directive to move that inventory to a

quarantine location.

This field is available only for selected work order types where replenishment is permitted. For a complete list, see

the Fields that are specific to work order types section.

Use the L inesLines  FastTab to establish conditions for applying the related actions that are specified on the LocationLocation

directive actionsdirective actions  FastTab. For each line, you can specify the minimum quantity and maximum quantity that the

actions should apply to. You can also specify that the actions should apply to a specific inventory unit.

Sequence numberSequence number  – Enter the sequence that each location directive line should be processed in for the

selected work type. You can change the sequence as you require by using the Move upMove up and Move downMove down

buttons on the toolbar.

From quantityFrom quantity  – Specify the start of the range of quantities that the line applies to. Specify the quantity

in the unit of measure that is selected in the UnitUnit field.

To quantityTo quantity  – Specify the end of the range of quantities that the line applies to. Specify the quantity in

the unit of measure that is selected in the UnitUnit field.

UnitUnit – Select the unit of measure for the items. You can specify a minimum quantity and a maximum

quantity that the directive should apply to, and you can specify that the directive should be for a specific

inventory unit. The UnitUnit field is used only for quantity evaluation. To determine whether the location

directive line is applicable at all, the system uses the quantity in the unit that is specified on that line.

Every time that it reaches a location directive line, the system tries to convert the demand unit to the unit
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that is specified on the line. If the unit of measure conversion doesn't exist, the system moves on to the

next line.

Locate quantityLocate quantity  – This field is used only during attempts to put or locate items in the warehouse.

(Therefore, it applies only when the Work typeWork type field is set to Put). Select one of the following values to

specify the quantity that is used to evaluate whether a quantity is within the From quantityFrom quantity  to ToTo

quantityquantity  range:

L icense plate quantityL icense plate quantity  – Use the quantity on the license plate that is being received.

Unitized quantityUnitized quantity  – Use the quantity that is used during the transaction. For example, you receive a

quantity of 1,000 in a warehouse and break it into 10 license plates, each of which has a quantity of

100. In this case, you can use a quantity of 1,000 items instead of the license plate quantity of 100.

Remaining quantityRemaining quantity  – Use the quantity that must still be received on the purchase order line that is

being processed.

Expected quantityExpected quantity  – Use the total quantity of the purchase order line, regardless of what has already

been received.

Restr ict by unitRestr ict by unit – This check box lets you make the location directive line specific to a unit of measure

or multiple units of measure. Select it to restrict the units of measure that are considered valid selection

criteria for the location directive lines. This functionality works only for location directives where the

Work typeWork type field is set to Pick.

For example, when you reserve quantities, you want to reserve pallets only from a specific set of

locations. In this case, the lines will restrict that sequence to pallets in such a way that any quantity that is

less than a pallet won't be selected for the location directive.

Note that the Restr ict by unitRestr ict by unit check box doesn't control the unit or units that are applied on work lines.

The unit restriction applies only to the units that are made available via the unit sequence group. For

example, an item is associated with a unit sequence group that includes both the pallets unit and the pcs

units. A unit of measure has been defined, where 1 pallet = 100 pcs, and the location directive uses the

Restr ict by unitRestr ict by unit functionality only for pallets. Furthermore, a work template has been defined that limits

the work header creation to 50 pcs. In this case, work lines of 50 pcs will be created. To specify the unit of

measure for restriction, follow these steps:

1. On the L inesLines  FastTab, select Restr ict by unitRestr ict by unit on the toolbar. (This button becomes available only after

you select the Restr ict by unitRestr ict by unit check box on the line and then select SaveSave.)

2. On the Restr ict by unitsRestr ict by units  page, in the UnitUnit field, select the unit of measure that you want to restrict

by for the pick and put processes.

Round up to unitRound up to unit – This field works together with the Restr ict by unitRestr ict by unit check box. For example, if

Restr ict by unitRestr ict by unit and Round up to unitRound up to unit are selected on the location directive line, the work that is

generated from the directive for raw material picking should be rounded up to a multiple of one of the

handling unit that is specified on the Restr ict by unitRestr ict by unit page.

This Round up to unitRound up to unit  setup works only for the Raw material picking work order type, and only for location

directives where the Work typeWork type field is set to Pick.

Locate Packing QtyLocate Packing Qty  – If you specify a packing quantity on a sales order, transfer order, or production

order, this check box lets you restrict the system so that it can select only locations that have at least that

packing quantity.
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This functionality works only with location directives of the Pick type.

Allow SplitAllow Split – Specify whether the location directive can split the quantity that is being received or

reserved across multiple warehouse locations, or whether the whole quantity must be located in a single

location or reserved from a single location to create work.

Immediate replenishment templateImmediate replenishment template – Use this field to create a connection to a replenishment

template, so that replenishment is started immediately if items aren't allocated. If you leave this field

blank, item replenishment won't be started until all lines of the location directive have been processed.

This field is available only for selected work order types where replenishment is permitted. For a complete list, see

the Fields that are specific to work order types section.

You can define multiple location directive actions for each line. Once again, a sequence number is used to

determine the order that the actions are assessed in. At this level, you can set up a query to define how the best

location in the warehouse is found. You can also use predefined StrategyStrategy  values to find an optimal location.

Sequence numberSequence number  – This field shows the sequence that the actions are processed in for the selected

work type. You can change the sequence by using the Move UpMove Up and Move DownMove Down buttons on the toolbar.

NameName – Enter the name of the location directive action. Be specific, so that the action that is performed is

clear from the name.

Fixed location usageFixed location usage – Specify which locations the location directive should consider. Select one of the

following values:

Fixed and non-fixed locationsFixed and non-fixed locations  – The location directive will consider all locations.

Only fixed locations for the productOnly fixed locations for the product – The location directive will consider only fixed locations for

products.

Only fixed locations for the product var iantOnly fixed locations for the product var iant – The location directive will consider only fixed

locations for product variants.

Allow negative inventor yAllow negative inventor y  – Select this check box to allow negative inventory at the specified

warehouse location in location directives.

Batch EnabledBatch Enabled – Select this check box to use batch strategies for items that are batch-enabled. It's

important that you select this check box for processes that use location directives to find locations to pick

batch number–tracked items from. In this way, the search for locations that hold batch number–tracked

items is included. If this check box is selected, and the StrategyStrategy  field is set to None, the system will move

on to the next action line.

StrategyStrategy  – To more easily and quickly define the actions that are associated with each location directive

line, you can select one of the following predefined strategies:

NoneNone – No strategy will be used.

Match packing quantityMatch packing quantity  – This strategy verifies whether a pick location has the specified packing

quantity. This strategy is valid only when the Work typeWork type field is set to Pick.

ConsolidateConsolidate – This strategy consolidates items in a specific location when similar items are already

available. This strategy is valid only when the Work typeWork type field is set to Put. A typical setup for put tries
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to consolidate on the first action line and then, on the second line, tries to put without consolidation.

Consolidation of goods makes later picking more efficient.

FEFO batch reser vationFEFO batch reser vation – This strategy uses first expiry, first out (FEFO) batch reservations. Use it

when inventory is located by using a batch expiration date and allocated for batch reservation. You

can use this strategy only for batch-enabled items. It's valid only when the Work typeWork type field is set to

Pick.

Round up to the full LP and FEFO batchRound up to the full LP and FEFO batch – This strategy combines the elements of the FEFO batch

reservation and Round up to a full LP strategies. It's valid only for batch-enabled items and location

directives that have a work type of Pick. The line must be batch-enabled to use the FEFO batch

reservation strategy, and the Round up to a full LP strategy can be used only for replenishment. If this

strategy is configured together with a location stocking limit, it can cause the selected put work

location to be overloaded and stocking limits to be ignored.

Round up to a full LPRound up to a full LP – This strategy is used to round up the inventory quantity so that it matches

the license plate quantity that is assigned to the items that must be picked. You can use this strategy

only for replenishment location directives of the Pick type. If this strategy is configured together with a

location stocking limit, it can cause the selected put work location to be overloaded and stocking limits

to be ignored.

L icense plate guidedLicense plate guided – Use this strategy when you release the order to the warehouse to create the

pick-and-put work. You can use this approach for multiple license plates. This strategy will try to

reserve and create picking work against the locations that hold the requested license plates that have

been associated with the transfer order lines. However, if these actions can't be completed, but you still

want to create picking work, you should fall back to another strategy for location directive actions.

Depending on your business process requirements, you might also want to search for inventory in

another area of the warehouse.

Empty location with no incoming workEmpty location with no incoming work – Use this strategy to locate empty locations. A location is

considered empty if it has no physical inventory and no expected incoming work. You can use this

strategy only for location directives that have a work type of Put.

Location aging FIFOLocation aging FIFO – Use the first in, first out (FIFO) strategy to ship both batch-tracked items and

non-batch-tracked items, based on the date when the inventory entered the warehouse. This

capability can be especially useful for non-batch-tracked inventory, where no expiration date is

available to use for sorting. The FIFO strategy finds the location that contains the oldest aging date,

and then allocates picking based on that aging date.

Location aging LIFOLocation aging LIFO – Use the last in, last out (LIFO) strategy to ship both batch-tracked items and

non-batch-tracked items, based on the date when the inventory entered the warehouse. This

capability can be especially useful for non-batch-tracked inventory, where no expiration date is

available to use for sorting. The LIFO strategy finds the location that contains the newest aging date,

and then allocates picking based on that aging date.

For this example, consider a purchase order process where the location directive must find free capacity within a

warehouse for inventory items that have just been registered at the receiving dock. First, you need to find free

capacity within the warehouse by consolidating with existing on-hand inventory. If consolidation isn't possible,

then you need to find an empty location.

For this scenario, you must define two location directive actions. The first action in the sequence must use the

Consolidate strategy, and the second should use the Empty location with no incoming work strategy. Unless you

define a third action to handle an overflow scenario, two outcomes are possible when there is no more capacity

in the warehouse: work can be created even though no locations are defined, or the work creation process can

fail. The outcome is determined by the setup on the Location directive failuresLocation directive failures  page, where you can choose

whether to select the Stop work on location directive failureStop work on location directive failure option for each work order type.
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Additional resources

NOTENOTE

After you create location directives, you can associate each directive code with a work template code for work

creation. For more information, see Control warehouse work by using work templates and location directives.

Video: Warehouse management configuration deep dive

Help topic: Control warehouse work by using work templates and location directives

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/supply-chain/warehousing/control-warehouse-location-directives
https://community.dynamics.com/365/b/techtalks/posts/warehouse-management-configuration-deep-dive-october-14-2020
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Configure product filters for warehouse transactions
2/18/2021 • 8 minutes to read • Edit Online

Prerequisites
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Before you start to configure products on the ReleasedReleased
product detailsproduct details  page, you must turn on warehouse
processing for the product's storage dimension group.

Go to Product information management > Setup >Product information management > Setup >
Dimension and variant groups > Storage dimensionDimension and variant groups > Storage dimension
groupsgroups, and select or create a storage dimension group
where the Use warehouse management processesUse warehouse management processes
option is set to Yes.

If you will use customer filters and/or vendor filters, you
must enable their use in Warehouse management
parameters.

Go to Warehouse management > Setup > WarehouseWarehouse management > Setup > Warehouse
management parametersmanagement parameters . On the Product filtersProduct filters  tab,
set the Enable customer filtersEnable customer filters  and/or Enable vendorEnable vendor
filtersfilters  option to Yes.

Set up product filters

This topic describes how to configure product filters and filter codes to categorize inventory items in a

warehouse. You can also use filters to specify which customers can order a particular item and which items can

be purchased from a particular vendor.

Additionally, you can set up and use product filters to automatically organize inventory items in a warehouse

and combine filtered items into filter groups. Filters can be used to put items into categories for handling,

purchasing, and selling processes. You might want to group items together or separate them from each other

when the way that they are handled is based on weight or handling restrictions. You can also specify which

customers or vendors an item can be purchased from or sold to.

The following table shows the prerequisites that must be in place before you start.

Product filters provide up to 10 Filter  titleFilter  title characteristics, which are enumeration (enum) values. These enum

values are available for selection when you create a product filter. The enum values Code 1 through Code 10 are

system-defined and represent a specific characteristic or attribute of an item. For example, Code 1 might

represent items that have a hazardous material classification. Code 2 might represent items that only vendors

can purchase. Product filters then define the specific Filter  codeFilter  code value that is associated with a Filter  titleFilter  title

value.

1. Go to Warehouse management > Setup > Product filters > Product filtersWarehouse management > Setup > Product filters > Product filters .

2. On the Action Pane, select NewNew  to add a product filter to the grid.

3. In the Filter  titleFilter  title field, select a value.

4. In the Filter  codeFilter  code field, enter a value.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/filters-and-filter-codes.md
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5. In the Descr iptionDescr iption field, enter a name for the code. For example, Code 2 might represent vendors. You

can then create a product filter for a specific vendor or group of vendors. For more information, see the

Setup vendor filter codes section later in this topic.

You can use filter groups to group filter codes. This capability is helpful when a group is used in a query in a

location directive, and you want to search for the group instead of a series of codes. Each filter group is

associated with an item group.

Not all product filter groups are available for filter codes that are higher than Code 4 (that is, Code 5 through Code 10).

For example, for released products, although all the product filter codes will be added, the grouping of filter codes won't

be updated. This behavior might be updated in later releases.

To set up filter groups, follow these steps.

1. Go to Warehouse management > Setup > Product filters > Product filter  groupsWarehouse management > Setup > Product filters > Product filter  groups .

2. On the Action Pane, select NewNew .

3. In the Group 1Group 1  and Group 2Group 2  fields, enter the names that will be used to categorize items.

4. On the DetailsDetails  FastTab, select NewNew  to add a line.
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Set up filter codes on item groups

5. In the Star t date/timeStar t date/time and End date/timeEnd date/time fields, enter start and end dates for the filter group.

6. In the Item groupItem group field, select the item group that the product filter should apply to.

7. In the Code 1Code 1  through Code 10Code 10  fields, select the filter codes to include in the group, as required.

If you receive an error message when you close the page, a code setup might be missing. On the Item groupsItem groups page, you

can make the codes mandatory for an item group by selecting the Assign filter code 1 for item groupAssign filter code 1 for item group, Assign filterAssign filter

code 2 for item groupcode 2 for item group, and so on, check boxes.

By setting up filter codes on an item group, you can make the codes that are required for products that are

attached to that item group.

To set up filter codes on item groups, follow these steps.

1. Go to Inventor y management > Setup > Inventor y > Item groupsInventor y management > Setup > Inventor y > Item groups .

2. On the Action Pane, select NewNew  to create an item group.

3. In the Item groupItem group field, enter a name.

4. In the NameName field, enter a description.

5. On the WarehouseWarehouse FastTab, in the Filter  requiredFilter  required section, select the check boxes for the filter codes that

must be specified for products that are associated with the item group.

To update a released product, open its Released product detailsReleased product details  page, and then, on the Action Pane,

select EditEdit. The filters that are associated with codes then become available on the WarehouseWarehouse FastTab.

6. In the Item group filterItem group filter  section, select the check boxes for the filters that must match for the filter group

to be the default filter group for an item.

For example, if the Use filter  code 1Use filter  code 1  and Use filter  code 2Use filter  code 2  check boxes are selected, both filter code 1

and filter code 2 of the item must match the setup of the filter group for the item group before the filter

group can be selected. When you create a new item, the selected filter group will be the default filter
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Specify filter codes for released products

Set up generally available items

NOTENOTE

Set up customer product filters

group in the Group 1Group 1  and Group 2Group 2  fields on the WarehouseWarehouse FastTab of the Released product detailsReleased product details

page.

Product filter codes are enabled only for items that use advanced warehouse management.

Follow these steps to specify filter codes for released products. For example, you can use filter codes to group

hazardous products that specific vendors purchase.

1. Go to Product information management > Products > Released productsProduct information management > Products > Released products .

2. On the Action Pane, select NewNew  to create a product.

3. In the New released productNew released product dialog box, enter the data that is required to create the base of a new

product, and then select OKOK.

Product filter codes aren't enabled unless the item group that is attached to the product has been

configured for filter codes.

For more information, see Create a new product.

4. On the WarehouseWarehouse FastTab, in the Product filter  codesProduct filter  codes  section, select filter codes for the Code 1Code 1

through Code 10Code 10  fields, as required, to specify filter codes for the product.

You can make specific inventory items available only for customers, only for vendors, or for both customers and

vendors.

Customer and vendor filters don't apply to any item that is set up as generally available.

To set up generally available items, follow these steps.

1. Go to Warehouse management > Setup > Product filters > Generally available productsWarehouse management > Setup > Product filters > Generally available products .

2. On the Action Pane, select NewNew  to create a record.

3. In the Customer or vendorCustomer or vendor  field, select Customer, Vendor, or All to make the items available for

customers, vendors, or both.

4. In the Star t date/timeStar t date/time field, enter the date and time when the item will become available.

5. In the Item groupItem group field, select an item group.

6. In the Code 1Code 1  through Code 10Code 10  fields, select the filter codes to limit the items that are generally

available.

When you select an item group, you set that group of items as generally available. By selecting filter

codes in these fields, you limit the items that are available.

You can use this optional procedure to specify items that should be available for a customer in addition to the



 Set up vendor product filters

NOTENOTE

See also
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items that are made available via the filter setup on the Generally available itemsGenerally available items page. You can set up

multiple filters for a single customer.

To set up customer filter codes, follow these steps.

1. Go to Sales and marketing > Customers > All customersSales and marketing > Customers > All customers .

2. Select a customer.

3. On the Action Pane, on the CustomerCustomer  tab, in the Set upSet up group, select Product filtersProduct filters .

4. On the Product filter  codesProduct filter  codes  page, on the Action Pane, select NewNew .

5. In the Star t date/timeStar t date/time and End date/timeEnd date/time fields, enter start and end dates for the selected item group.

6. In the Item groupItem group field, select an item group.

7. In the Code 1Code 1  through Code 10Code 10  fields, select the filter codes to use as criteria to limit the items that are

available for customers in the selected item group. You must make a selection for every filter code that is set

up for the item group.

You can use this optional procedure to specify items that should be available for a vendor in addition to the

items that are made available via the filter setup on the Generally available itemsGenerally available items page. You can set up

multiple filters for a single vendor.

To set up vendor filter codes, follow these steps.

1. Go to Procurement and sourcing > Vendors > All vendorsProcurement and sourcing > Vendors > All vendors .

2. Select a vendor.

3. On the Action Pane, on the VendorVendor  tab, in the Set upSet up group, select Product filtersProduct filters .

4. On the Filter  codesFilter  codes  page, on the Action Pane, select NewNew .

5. In the Star t date/timeStar t date/time and End date/timeEnd date/time fields, enter start and end dates for the selected item group.

6. In the Item groupItem group field, select an item group.

7. In the Code 1Code 1  through Code 10Code 10  fields, select the filter codes to use as criteria to limit the items that are

available for vendors in the selected item group. You must make a selection for every filter code that is set up

for the item group.

The setup of vendor product filters applies to released products where warehouse management processes are enabled for

the associated storage dimension group. The filter codes are used to determine whether the system will allow users to

purchase a given item from a given vendor when they create purchase order lines. Microsoft Dynamics 365 Supply Chain

Management has two methods for handling vendor approval. If one or more released products exist where the

Approved vendor check methodApproved vendor check method field is set to Warning only or Not allowed, both vendor approval methods could be

enabled for those items. This situation might cause issues when users create purchase order lines.

For more information see the blog post WMS-Warehouse Filter Codes

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

http://blog.dynamics-for-operations.com/2017/09/26/wms-warehouse-filter-codes/
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Example – Purchase order receiving
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24 FLOOR D0013 M 300 Ea

24 FLOOR D0013 L 240 Ea

24 FLOOR D0013 S 360 Ea

You can use the Location stocking limitsLocation stocking limits  page (Warehouse management > Setup > Warehouse >Warehouse management > Setup > Warehouse >

Location stocking limitsLocation stocking limits ) to control the load capacity at warehouse locations without having to use the more

advanced processes for volumetric calculations of physical products.

The purpose of location stocking limits is to evaluate the maximum quantity that a location can contain. You can

set up the feature on any of three levels, each of which has its own tab on the Location stocking limitsLocation stocking limits  page:

Products

Product variants

Container types

For each level, you can define different field values. The system will then evaluate the capacity of a specific

location, based on the QuantityQuantity  and UnitUnit values for each row. It will select the most detailed matching record

first. For example, a row that has a value in the Location profile IDLocation profile ID field will be evaluated before a row that has

a value only in the WarehouseWarehouse field. The remaining capacity will also be evaluated, based on the QuantityQuantity

value for the location stocking limit record that is used.

In the ProductsProducts  section of the page, you can define the following field values for the search for location

stocking limits:

Warehouse

Location profile ID

Location

Pack size category ID

Item number

Unit

You don't have to define a UnitUnit  value for each location stocking limit record. The location capacity calculations will be

based on the inventory unit quantities. If no unit conversion is defined for a value that is used, the location stocking limit

record will be skipped, as if another Item numberItem number  value is defined for it.

This example is based on a clean USMF demo data set, where the following values are set on the ProductProduct

var iantsvar iants  tab of the Location stocking limitsLocation stocking limits  page.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/location-stocking-limits.md
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Process the exampleProcess the example

Different unit of measure product variants are set up for the products. These variants are aligned with the

location stocking limits for three pallets (PL):

S ize M:Size M: 1 PL = 100 each (Ea)

S ize L :S ize L : 1 PL = 80 Ea

Size S :S ize S : 1 PL = 120 Ea

Therefore, each location where the Location profile IDLocation profile ID value is set to FLOOR can carry 3 PL of item number

D0013.

In this example, you will run a purchase order receiving flow for two lines. However, you must first update the

demo data in the following way to ensure that the locations allow mixed items to be carried, only the empty

locations FL-002 through FL-004 are used, and there is no open inbound work.

WA REH O USEWA REH O USE IT EM  N UM B ERIT EM  N UM B ER SIZ ESIZ E Q UA N T IT YQ UA N T IT Y UN ITUN IT

24 D0013 S 4 PL

24 D0013 L 4 PL

1. For location FL-001, change the value of the Location profileLocation profile field from FLOOR to FLOOR-05.

2. For the FLOOR location profile, set the Allow mixed itemsAllow mixed items option to Yes.

3. Create a purchase order that has the following two lines.

You will first receive a quantity of 4 of unit PL in size S, and review the put line locations for the work that is

created. You will then receive a quantity of 4 of unit PL in size L, and review the put line locations for the work

that is created.

1. In the warehouse app, sign in by using 24 as the user ID and 1 as the password.

2. Select InboundInbound > Purchase ReceivePurchase Receive.

3. Receive 4 PL of item number D0013 in size S.

4. Review the putaway work that was created. You should see the following result:

3 PL -> FL-002

1 PL -> FL-003

5. Receive 4 PL of item number D0013 in size L.

6. Review the putaway work that was created. You should see the following result:

1 PL -> FL-003

3 PL -> FL-004

Based on the results, you might conclude that the system failed to allocate the correct putaway locations.

Otherwise, why did the system add only 1 PL of size L to location FL-003 in the last step, not 2 PL? That is, why

isn't there is a total of 3 PL for putaway to that location?

To explain this apparent failure, you must understand the selection criteria for the location stocking limits. The

system selects the most detailed matching record. In this example, the most detailed matching record is the line

where the S izeSize value is L, the QuantityQuantity  value is 240, and the UnitUnit value is Ea. Because you already have open

work from the previous receipt of a quantity of 120 Ea of size S, the remaining capacity is calculated as 240 –

120 = 120 Ea. Therefore, the remaining capacity can carry only 1 PL of 80 Ea.
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You can't use location stocking limits to control, for example, the replenishment of items that have different quantities in

the same location. In this case, use a replenishment template.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Setup demo

Enable wave step codesEnable wave step codes

Create new wave step codesCreate new wave step codes

Wave step codes are codes that users can set up and use to link specific instances of wave methods to a

corresponding template. The templates include templates for replenishment, containerization, label printing,

load building, and sorting.

When wave step codes aren't used, users must enter free text to reference a specific template from the wave

method instance. Free text is prone to errors because users must make sure that the wave step text that they add

for a specific wave step method in a wave template exactly matches the wave step text in the target template.

Wave step codes for a specific wave step type are set up on a separate page. For every wave step method

instance in a wave template that requires a wave step code, the wave step code must be selected in a drop-down

list. Selection in a drop-down list replaces free text entry and helps reduce the risk and impact of human error.

Setup codes are used to link a wave step method in a wave template to a target template for the method.

Use of the wave step codes feature is optional. It is enabled organization-wide for all legal entities.

For this demo, demo data must be installed, and you must use the USMFUSMF demo data company.

Follow these steps to turn on the wave step codes feature.

1. Go to Feature ManagementFeature Management.

2. Select to enable the feature called Organization-wide Wave Step CodeOrganization-wide Wave Step Code.

All existing wave step free texts in all legal entities are upgraded to the new structure. After this upgrade is

completed for all legal entities, then the feature is enabled. If the feature cannot be enabled for one or more

legal entities, then the feature is not enabled for any legal entities.

During the enablement, validations are done during the data upgrade. If the upgrade fails, you receive an error

message. An upgrade might fail because of the following conflicts:

Duplicate wave step free texts exist.

Customizations exist.

A wave step free text that is associated with a wave step method instance doesn't match the expected

template type.

After you've resolved any conflicts that are identified during the validations, you can retry to enable the feature.

When the feature has been enabled, the Wave step codesWave step codes  page (Warehouse management > Setup >Warehouse management > Setup >

Waves > Wave step codesWaves > Wave step codes ) becomes available. This page lists the wave step codes that were upgraded when

the Organization-wide Wave Step Code feature was enabled.

You can use the Wave step codesWave step codes  page to create and delete wave step codes.

Every new wave step code and its associated ID must be unique across all wave step types, and they must be

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/wave-step-codes.md
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defined for a specific wave step type.

After you've defined the appropriate wave step codes, they can be applied to the wave process methods.

To apply wave step codes, go to the appropriate target template. Here are the target templates that the wave

step codes are designated to point to:

Replenishment templates:Replenishment templates: Warehouse management > Setup > Replenishment > Replenishment

templates

Load build templates:Load build templates: Warehouse management > Setup > Load > Load build templates

Sor t templates:Sor t templates: Warehouse management > Setup > Packing > Outbound sorting templates

Container ization templates:Container ization templates: Warehouse management > Setup > Containers > Container build templates

Label pr inting templates:Label pr inting templates: Warehouse management > Setup > Document routing > Wave label templates

The templates in this list are applied when they are referenced from a wave process method that is selected in a

wave template. When the wave step code on a wave process method in a wave template matches the wave step

code in one of the templates types, the template is applied.

The following procedure helps guarantee that the replenishment template that you created will be applied for

the wave template.

1. Go to Warehouse management > Setup > Waves > Wave step codesWarehouse management > Setup > Waves > Wave step codes , and create a wave step code for

the ReplenishmentReplenishment type.

2. Go to Warehouse management > Setup > Replenishment > Replenishment templatesWarehouse management > Setup > Replenishment > Replenishment templates , and create a

replenishment template.

3. In the replenishment template, select the wave step code that you created for the ReplenishmentReplenishment type.

4. Go to Warehouse management > Setup > Waves > Wave templatesWarehouse management > Setup > Waves > Wave templates , and select the wave template

that you intend to use.

5. In the template, on the MethodsMethods  FastTab, select the ReplenishmentReplenishment method.

6. In the Wave step codeWave step code field, select the wave step code that you selected in the replenishment template.

You perform these steps for each legal entity.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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This guide describes how to set up the criteria that determine what work is generated for a warehouse when a

wave is processed, and whether waves are processed manually or automatically. You specify the criteria by

setting up wave templates and queries that match a wave with released lines in sales orders, production orders,

or kanban orders. Wave processing is used in warehouses that use the functionality in the Warehouse

management module, and not those that use the functionality in the Inventory management module. You can

run this procedure in demo data company USMF.

1. Go to Navigation pane > Modules > Warehouse management > Setup > Waves > WaveNavigation pane > Modules > Warehouse management > Setup > Waves > Wave

templatestemplates .

2. Click NewNew .

3. In the Wave template nameWave template name field, type a value. When you set up a wave template, you specify the

sequence in which the templates will be matched to released lines on sales orders, production orders, or

kanbans. When a line is released to the warehouse or to production, it uses the first wave template that it

meets the criteria for. We recommend that you put templates with the most specific criteria at the top of

the list. The broader the criteria, the more likely it is for a line to meet the criteria, and this could lead to

lines being assigned to the wrong wave.

4. In the Wave template descr iptionWave template descr iption field, type a value.

5. In the S iteSite field, enter or select a value. If you're using USMF, you can select site 2.

6. In the WarehouseWarehouse field, enter or select a value. If you're using USMF, you can select warehouse 24.

7. Set the Automate wave creationAutomate wave creation field to YesYes . Select this option to automatically create a wave when a

sales order, production order, or kanban is released to the warehouse.

8. Set the Process wave at release to warehouseProcess wave at release to warehouse option to YesYes . Select this option to automatically

process the wave and create work when a line is released to the warehouse.

9. Set the Automate wave release optionAutomate wave release option to YesYes . Select this option to automatically release the wave.

The picking work is created and made available on mobile devices.

10. Set the Assign to open waves optionAssign to open waves option to YesYes . Lines are assigned to waves based on the query filter for

the wave template.

11. Set the Process wave automatically at threshold optionProcess wave automatically at threshold option to YesYes . Select this option to automatically

process the wave when its values reach the thresholds for weight, shipment, and lines specified in the

Wave thresholds field group. This option is available only if Shipping is selected in the Wave template

type field.

12. Set the Automate replenishment work release optionAutomate replenishment work release option to YesYes . Select this option to create demand-

based replenishment work and release it automatically. You must add the replenishment wave method to

the wave template, and create a replenishment template of the type Wave demand.

13. Expand the MethodsMethods  section.

Wave template methods allow you to control the sequence of activities that each wave is going

through when it's processed. For example, you might have a method for wave replenishment. When

you add a method, it's automatically listed in the appropriate location in the sequence of steps. If

you've set the Automate replenishment work release option to Yes, you need to add the replenish

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/tasks/configure-wave-processing.md
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method here.

Wave attributes act as filters, to restrict the kind of items that can use the wave. For example, you

could specify an item group.

14. Click SaveSave.

15. Close the page.

16. Go to Warehouse management > Setup > Warehouse management parametersWarehouse management > Setup > Warehouse management parameters .

17. Expand the Wave processingWave processing section.

18. In the Wave processing batch groupWave processing batch group field, enter or select a value.

19. Set the Process waves in batch optionProcess waves in batch option to YesYes .

20. In the Wait for lock (ms)Wait for lock (ms)  field, enter a number. Enter the time, in milliseconds, that an allocation step

will wait for a system resource that is locked by another allocation step. When this time is exceeded, the

wave is not processed and an error message is displayed.

21. Click SaveSave.

22. Close the page.

23. Go to Navigation pane > Modules > Production control > Setup > Production controlNavigation pane > Modules > Production control > Setup > Production control

parametersparameters .

24. In the Release to warehouseRelease to warehouse field, select an option.

For sales orders and kanban orders, inventory must be reserved before the order is released to the warehouse.

Otherwise, the items or allocation lines cannot be processed in a wave. For production orders, you also have the

option of choosing Allow partial reservation. For example, this is useful if you have the materials that you need

to start production, and can then wait until the additional materials become available to finish the process. If you

select this option, you must manually repeat the release to warehouse process when the additional materials

become available.

25. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Schedule work creation during wave
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Enable the Schedule work creation feature
Enable the feature in feature managementEnable the feature in feature management

NOTENOTE

Manually enable batch processing of wavesManually enable batch processing of waves

Manually enable the new wave step method for existing wave templatesManually enable the new wave step method for existing wave templates

Use the Schedule work creation feature as part of your waving process to help increase wave processing

throughput by having the system create work using parallel processing.

When the functionality is enabled, planned work will automatically get created, which the system will eventually

process to create actual work. If the number of wave load lines reaches a predetermined threshold, the system

will create actual work more quickly by applying parallel, asynchronous processing.

Before you can use the Schedule work creation feature, it must be turned on in your system. Admins can use the

Feature management workspace to check the status of the feature and turn it on if it's required. There, the

feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Schedule work creation

The Organization-wide work blocking feature must be enabled before you can enable Schedule work creation.

To take advantage of a parallel asynchronous method to create warehouse work, your wave process must be

running in batch. To set this up:

1. Go toWarehouse managementWarehouse management>>Setup > Warehouse management parametersSetup > Warehouse management parameters .

2. On the GeneralGeneral  tab, set Process waves in batchProcess waves in batch to Yes. Optionally, you can also select a dedicated

Wave processing batch groupWave processing batch group to prevent your batch queue processing from running at the same time

as other processes.

3. Set the Wait for lock (ms) timeWait for lock (ms) time, which applies when the system is processing several waves at the

same time. For most larger waving processes, we recommend a value of 60000.

Start by creating the new wave step method and enabling it for parallel asynchronous task processing.

1. Go toWarehouse management >Warehouse management >Setup > Waves > Wave process methodsSetup > Waves > Wave process methods .

2. SelectRegenerate methodRegenerate method and note that WHSScheduleWorkCreationWaveStepMethod has been added

to the list of wave process methods you can use in your shipping wave templates.

3. Select the record with the Method nameMethod name WHSScheduleWorkCreationWaveStepMethod and select TaskTask

configurationconfiguration.

4. To add a new row to the grid, select NewNew  on the Action Pane and use the following settings:

WarehouseWarehouse - Select the warehouse you will use to schedule work creation processing.

Maximum number of batch tasksMaximum number of batch tasks  - Specify a maximum number of batch tasks. In most cases,

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/configure-wave-schedule-work-creation.md


Set wave task processing threshold data

Work with the feature

this value should be in the range from 8-16, however we recommend that you experiment with

the optimal setting based on your scenarios.

Wave processing batch groupWave processing batch group - Select a dedicated wave processing batch group to optimize

your batch queue processing.

Now you are ready to update an existing wave template (or create a new one) to use the Schedule work creation

wave processing method.

1. Go toWarehouse managementWarehouse management>>Setup > Waves > Wave templatesSetup > Waves > Wave templates .

2. Select EditEdit on the Action Pane.

3. In the list pane, select the wave template you would like to update (if you are testing using demo data,

then you could use 24 Shipping default).

4. Expand the MethodsMethods  FastTab and select the row with the NameName Schedule work creation in the

Remaining methodsRemaining methods  grid.

5. Select the arrow pointing to the Selected methodsSelected methods  column to move the selected row to that column.

(You can only have one selected method at a time that uses either

WHSScheduleWorkCreationWaveStepMethod or createWork, so the existing row with Method nameMethod name

createWork is automatically moved to the Remaining methodsRemaining methods  grid.)

The system will create default wave task processing threshold data the first time a wave process runs using any

task-based processing. The data is used to control when wave processing will run asynchronously and be task-

based, which enables it to process and create work in parallel.

The default data will initially use a threshold value of 15 for the minimum number of load lines

(MINIMUMWAVELOADLINES). This means that when the system processes a wave with more than 15 loads

lines, it will use asynchronous task processing. You can manually insert/update this data in the

WHSWaveTaskProcessingThresholdParametersWHSWaveTaskProcessingThresholdParameters  table in your test environments, but if you need to change

this setting in a production environment, you must contact Microsoft Support to request the update.

When the Schedule work creation functionality is enabled, wave processing will create planned work, which will

eventually be used by the new work creation process. During work creation, the work will be blocked using the

Organization-wide work blocking feature.

The following flowchart shows how planned work is created during wave processing.



Planned workPlanned work

Batch job for the work creation processBatch job for the work creation process

NOTENOTE

The Planned work detailsPlanned work details  page (Warehouse management > Work > Planned work detailsWarehouse management > Work > Planned work details ) shows

information about the planned work, which is initially created during wave processing. The following ProcessProcess

statusstatus  values are available:

QueuedQueued - The planned work is waiting to be used to create work.

CompletedCompleted - The planned work has been used to create work.

FailedFailed – The wave processing has failed. Note that the planned work can be in a FailedFailed state with or without

related actual work. When the actual work creation process fails, the actual work remains in status Cancelled.

To view the batch jobs for processing waves, select Batch jobsBatch jobs  on the Action Pane on the All wavesAll waves  page.

From here, you can view all the batch task details for each of the batch job IDs.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Set up and use wave label printing
2/18/2021 • 31 minutes to read • Edit Online

NOTENOTE

NOTENOTE

Wave label printing offers an alternative approach to label printing by introducing a new wave step method that

lets you create and print labels directly from the wave template during wave execution. Therefore, the labels will

already be available before workers run the work order on a mobile device. Workers can then attach the

required labels during picking instead of after picking.

Wave label printing uses Zebra Programming Language (ZPL) to create label layouts. A label layout is divided

into three sections (header, body, and footer) to allow for labels that have repeating structure. Wave label

templates tell the system which label layout to use. Users can specify which printer is used. They can also print

labels on several printers at the same time, as they require. The Wave label histor yWave label histor y  page shows a record of all

labels that have been created by using this setup.

You can print and collate labels based on work headers, you can print break labels per work header, and you can

print container content labels, case labels, and other similar labels.

This functionality doesn't replace existing label printing functionality that is based on document routing.

Wave label printing offers the following enhancements:

Print labels according to the number of cartons on a single work line, without using containerization. (A

"carton" is a unit that is designated on unit sequence group lines.)

Print several different label sequences (for example, carton and pallet labels).

Include label enumeration (for example, 1/124, 2/124, ... 124/124), and define the range of enumeration (for

example, work line, load line, or shipment).

Create and print a bill of lading ID on labels before the bill of lading is generated.

Create a unique serial shipping container code (SSCC) for each carton, and include it on each label.

Create GS1-compliant number sequences for bill of lading IDs and SSCCs.

Reprint labels from both mobile devices and the rich client.

Void labels (for example, in short pick scenarios), and reprint them.

Clean up the wave label history.

Improvements to document routing layouts are shared between document routing layouts and wave label

layouts. (For more information, see Document routing layout for license plates.)

These enhancements make it more efficient to label cartons before palletization. They especially benefit

companies that ship to large retailers that automatically confirm order receipts by scanning each carton

separately.

You can implement the configuration scenarios that are described in this topic either separately or in combination,

depending on your business requirements. You can design several wave label templates that work in sequence (as

illustrated in scenario 3). For example, you can use scenario 1 to print carton labels and scenario 2 to print pallet labels (if

pallets in stock vary in size and composition).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/configure-wave-label-printing.md


Turn on the Wave label printing feature

Scenario 1: Wave label printing where a single wave label is generated

Make demo data availableMake demo data available

Make sure that the wave label method is availableMake sure that the wave label method is available

Configure a wave templateConfigure a wave template

Create a wave label layoutCreate a wave label layout

Before you can use the Wave label printing feature, it must be turned on in your system. Admins can use the

Feature management workspace to check the status of the feature and turn it on if it's required. There, the

feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Wave label printing

This scenario shows how a company can print shipping labels for a large retailer that automatically confirms

order receipts by scanning each carton separately.

This scenario shows the end-to-end flow.

To follow this scenario, you must have demo data installed, and you must select the USMFUSMF legal entity.

You might have to regenerate the wave process methods to make the wave label printing method available.

1. Go to Warehouse management > Setup > Waves > Wave process methodsWarehouse management > Setup > Waves > Wave process methods .

2. Confirm that waveLabelPr intingwaveLabelPr inting is in the list. If it isn't, select Regenerate methodsRegenerate methods  on the Action Pane to

add it.

Wave templates let you link specific instances of wave methods to a corresponding wave label template.

1. Go to Warehouse management > Setup > Waves > Wave templatesWarehouse management > Setup > Waves > Wave templates .

2. Select a template, such as 62 Shipping Default62 Shipping Default.

3. On the MethodsMethods  FastTab, move the Wave label pr intingWave label pr inting method to the Selected methodsSelected methods  column.

4. In the Selected methodsSelected methods  column, select the Wave label pr intingWave label pr inting method, and set its Wave step codeWave step code

field to PrintLabel. For more information about wave step codes, see Wave step codes.

The label layout controls what information is printed on the label and how it's laid out. Here, you enter the ZPL

code that is sent to the printer.

1. Go to Warehouse management > Setup > Document routing > Wave label layoutsWarehouse management > Setup > Document routing > Wave label layouts .

2. Create a record that has the following settings:

Label layout ID:Label layout ID: Carton

Descr iption:Descr iption: Carton (SSCC)

3. On the Action Pane, select SaveSave.

4. On the Action Pane, select Wave label row settingsWave label row settings .

The Wave label row settingsWave label row settings  page appears. Here, you can configure the dynamic part of the label.

5. Add a row that has the following settings:

Row Id:Row Id: WaveLabel

Row table name:Row table name: WHSWaveLabel

Row star t position:Row star t position: 0



NOTENOTE

This field defines the vertical position where the row will begin on the label.

Row height:Row height: 0

This field defines the height of each row (in points), according to the ZPL standard. The row height

is positive for horizontal labels and negative for vertical labels. Because there is just one row in this

example, you can set the value to 0 (zero).

Rows per page:Rows per page: 1

This field defines the number of rows that can be printed on each label.

This setup will cause a separate ZPL label to be printed for each record in the wave labels table.

6. Close the page.

7. On the Action Pane, select Edit quer yEdit quer y .

8. In the query editor dialog box, on the RangeRange tab, add a row that has the following settings:

Table:Table: Work lines

Derived table:Derived table: Work lines

Field:Field: Work type

Criter ia:Cr iter ia: Pick

This query ensures that only pick-type work lines will be printed on the label, not put-type work lines.

9. If you want to be able to print the bill of lading ID, on the JoinsJoins  tab, select the Work linesWork lines  table, and join

the ShipmentsShipments  table to it.

10. Close the query editor dialog box.

11. The Pr inter text LayoutPrinter text Layout FastTab has three sections where you can write printer code: Header sectionHeader section,

Body sectionBody section, and Footer sectionFooter section. In the Header sectionHeader section section, in the Label headerLabel header  field, enter

code for the required header. For example, if you're using Zebra printers, you can use the following code.



CT~~CD,~CC^~CT~
^XA~TA000~JSN^LT0^MNW^MTT^PON^PMN^LH0,0^JMA^PR8,8~SD15^JUS^LRN^CI0^XZ
^XA
^MMT
^PW812
^LL1218
^LS0
^FT85,505^A0N,28,28^FH\^FD$WHSShipmentTable.CustomerReq$^FS
^FO1,173^GB809,0,1^FS
^FO0,391^GB809,0,1^FS
^FO3,599^GB809,0,2^FS
^FO420,176^GB0,216,1^FS
^FO313,3^GB0,169,1^FS
^FO0,807^GB809,0,1^FS
^FT529,370^A0N,28,26^FH\^FD$WHSShipmentTable.BillOfLadingId$^FS
^BY2,3,132^FT25,344^BCN,,N,N
^FD>:(420)>38102>63^FS
^FT526,315^A0N,28,28^FH\^FD ^FS
^FT437,248^A0N,28,28^FH\^FDCARR: $WHSShipmentTable.SCAC$^FS
^FT425,201^A0N,23,24^FH\^FDCARRIER:^FS
^FT17,68^A0N,20,19^FH\^FDIntershipping, Inc.^FS
^FT15,99^A0N,20,19^FH\^FD1000 Shipping Lane^FS
^FT16,158^A0N,20,19^FH\^FD ^FS
^FT438,368^A0N,28,28^FH\^FDB/L#^FS
^FT15,128^A0N,20,19^FH\^FDShelbyville TN 38102^FS
^FT19,203^A0N,23,24^FH\^FD(420) SHIP TO POSTAL CODE^FS
^FT331,39^A0N,28,28^FH\^FDShip To:^FS
^FT14,39^A0N,28,28^FH\^FDShip From:^FS
^FT331,67^A0N,23,24^FH\^FDWAL-MART DC 1111A-ABC DIS^FS
^FT330,98^A0N,23,24^FH\^FDDEPT 10^FS
^FT329,166^A0N,23,24^FH\^FDSpringfield TN 39021^FS
^FT330,134^A0N,23,24^FH\^FD100 Main Street^FS
^FT19,504^A0N,28,28^FH\^FDPO#:^FS
^FT437,316^A0N,28,28^FH\^FDPRO#^FS
^FT105,371^A0N,28,28^FB130,1,0,C^FH\^FD(420)39021^FS

<Row name="WaveLabel">
^FT127,439^A0N,28,28^FH\^FD$WHSWaveLabel.SeqNum$^FS
^FT256,439^A0N,28,28^FH\^FD$WHSWaveLabel.NumberOfLabels$^FS
^FT17,439^A0N,28,28^FH\^FDCARTON^FS
^FT522,422^A0N,23,24^FH\^FDVPN:^FS
^FT74,1156^A0N,28,28^FH\^FDSSCC-18^FS
^FT21,579^A0N,28,28^FH\^FDItem name:^FS
^FT107,580^A0N,28,28^FH\^FD$WHSWaveLabel.LabelItemName$^FS
^FT576,423^A0N,23,21^FH\^FD$WHSWaveLabel.LabelItemId$^FS
^FT252,1155^A0N,32,31^FH\^FD(00)$WHSWaveLabel.WaveLabelId$^FS
^BY4,3,283^FT66,1115^BCN,,N,N
^FD>;>800$WHSWaveLabel.WaveLabelId$^FS
^FT194,439^A0N,28,28^FH\^FDof^FS
</Row>

^PQ1^XZ

12. In the Body sectionBody section section, in the Label bodyLabel body  field, enter ZPL code for the required body. Here is an

example.

13. In the Body sectionBody section section, in the Label footerLabel footer  field, enter ZPL code for the required footer. Here is an

example.



Create a wave label typeCreate a wave label type

Set up unit sequence groupsSet up unit sequence groups

Create a wave label templateCreate a wave label template

NOTENOTE
This setup will print one copy of each label. If you require more copies (for example, one copy for each side of the

pallet), set the nn value for the ^PQn^PQn section in the footer to the required number of copies. For example, to print

four copies of each label, specify ^PQ4^PQ4 .

Your label is now ready to use.

Wave label types are used to link wave label templates to a unit on unit sequence group lines.

1. Go to Warehouse management > Setup > Document routing > Wave label typesWarehouse management > Setup > Document routing > Wave label types .

2. Add a wave label type that has the following settings:

Label type:Label type: Carton

Descr iption:Descr iption: Carton

Next, set up the unit sequence group for the wave label type.

1. Go to Warehouse management > Setup > Warehouse > Unit sequence groupsWarehouse management > Setup > Warehouse > Unit sequence groups .

2. Select the Ea Box PLEa Box PL  group.

3. For the BoxBox line, set the Wave level typeWave level type field to Carton.

Next, create the wave label template for the wave label type.

1. Go to Warehouse management > Setup > Document routing > Wave label templatesWarehouse management > Setup > Document routing > Wave label templates .

2. Add a wave level template, and set the following values in the header :

Label template name:Label template name: Carton labels

Descr iption:Descr iption: Carton labels

Wave step code:Wave step code: PrintLabel

Warehouse:Warehouse: 62

3. On the GeneralGeneral  FastTab, set the Wave label typeWave label type field to Carton.

4. On the Wave label template detailsWave label template details  FastTab, add a new row that has the following settings:

Label layout ID:Label layout ID: Carton

Printer name:Pr inter name: Select an appropriate ZPL printer.

Run quer y:Run quer y: Yes (This setting is optional, but it's recommended for optimal performance.)

5. On the Action Pane, select SaveSave.

6. Optional: If you're setting up a customer-specific label design, you must create a query to find the

customer's account. On the Wave label template detailsWave label template details  FastTab, select Edit quer yEdit quer y . Then, in the query

editor dialog box, on the RangeRange tab, add a row that has the following settings:

Table:Table: Shipments

Derived table:Derived table: Shipments

Field:Field: Account number

Criter ia:Cr iter ia: Enter the relevant customer account number.

When you've finished, select OKOK to close the query editor dialog box.

7. On the Action Pane, select Edit quer yEdit quer y  to open the query editor dialog box for the whole label template.



Configure number sequence extensionsConfigure number sequence extensions

Create a sales order and release it to the warehouseCreate a sales order and release it to the warehouse

NOTENOTE

8. In the query editor dialog box, on the Sor tingSor ting tab, add a row that has the following settings:

Table:Table: Work lines

Derived table:Derived table: Work lines

Field:Field: Reference load line id (Record-ID)

Search direction:Search direction: Ascending

9. Select OKOK to close the query editor dialog box.

10. A message box prompts you to confirm the grouping reset operation. Select YesYes  to continue.

11. On the Action Pane, select Wave label template groupWave label template group.

12. In the Wave label template groupWave label template group dialog box, select the row where the Reference field nameReference field name field is

set to Reference load line id, and then select the Label build IDLabel build ID check box for this row.

This setup will create one label sequence ("Carton 1 of X") per load line throughout the wave, regardless of the

work grouping setup. This label sequence can be printed on the label layout.

Number sequence extensions control the GS1 compliance of specific number sequences. This configuration is

optional for the current scenario. For more information and configuration instructions, see Configure number

sequence extensions.

NOTENOTE

1. Go to Sales and marketing > Sales order > All sales ordersSales and marketing > Sales order > All sales orders .

2. Create a sales order that has the following settings:

Customer account:Customer account: US-001

Warehouse:Warehouse: 62

3. Add two sales order lines that have the following settings:

Sales order line 1:

Item number :Item number : A0001

Quantity:Quantity: 9024

Unit:Unit: ea (9024 ea = 376 Box = 47 PL)

Sales order line 2:

Item number :Item number : A0002

Quantity:Quantity: 9016

Unit:Unit: ea (9016 ea = 322 Box = 46 PL)

The items and quantities that are provided here are only examples. They must use the unit sequence group that

you defined earlier, appropriate unit conversions from ea to Box to PL must be defined for them, and they must

have stock in warehouse 62. For more information, see Unit of measure and stocking policies.

4. Select sales order line 1. Then, in the Sales order lineSales order line section, on the Inventor yInventor y  menu, select

Reser vationsReser vations .

5. On the Reser vationReser vation page, on the Action Pane, select Reser ve lotReser ve lot, and then close the page.



Scenario 2: Wave label printing for containerization (without wave
label records)

Make demo data availableMake demo data available

Make sure that the wave label method is availableMake sure that the wave label method is available

6. Repeat steps 4 and 5 for sales order line 2.

7. On the Action Pane, on the WarehouseWarehouse tab, select Release to warehouseRelease to warehouse.

The following events occur :

The system processes the created shipment by using the template that includes the label printing step.

The label layout will be used to define the format of the label, and the result will be a label that is

printed on the printer that is selected in the label template.

Wave labels are generated and printed. The number of labels will equal the number of cartons (in this

example, 376 Box labels for line 1 and 322 Box labels for line 2).

A new bill of lading ID is generated for the shipments. If you configured the number sequence

extensions, the wave label IDs will follow the SSCC-18SSCC-18  number format.

You can view and reprint wave labels from the following pages. On the Action Pane of each page, on the

ShipmentsShipments  tab, in the Related informationRelated information group, select Wave labelsWave labels .

All shipments > Shipment details

All loads > Load details

All waves

Wave labels

Wave label history

This scenario lets you print wave labels when you use containerization to automatically split items into cartons

and therefore don't require a wave label record. In this case, the container ID acts as a placeholder for the SSCC.

Here are the main differences between this scenario and scenario 1:

Wave label templates:Wave label templates: You won't select a wave label type on the wave label template, and you won't

require a label build grouping. Otherwise, you will configure the wave label template and link to the wave

template in the same way that is described in scenario 1. You must leave the wave label type blank to prevent

wave labels from being generated.

Wave label layouts:Wave label layouts: You will configure the wave label layout row settings for work lines instead of wave

label records. You must configure the row setting for the label layout by using the WHSWorkLineWHSWorkLine table

instead of the WHSWaveLabelWHSWaveLabel  table. The Rows per pageRows per page setting controls the number of rows that the

body section will have.

This configuration is also suitable for business scenarios where multiple different items are packed into one

labeled box or into a pallet, and this packing process can be defined by work creation (for example, work that is

grouped by shipment).

This scenario shows the end-to-end flow.

To follow this scenario, you must have demo data installed, and you must select the USMFUSMF legal entity.

You might have to regenerate the wave process methods to make the wave label printing method available.

1. Go to Warehouse management > Setup > Waves > Wave process methodsWarehouse management > Setup > Waves > Wave process methods .

2. Confirm that waveLabelPr intingwaveLabelPr inting is in the list. If it isn't, select Regenerate methodsRegenerate methods  on the Action Pane to

add it.



Set up a wave templateSet up a wave template

Create a wave label layoutCreate a wave label layout

Wave templates let you link specific instances of wave methods to a corresponding wave label template.

1. Go to Warehouse management > Setup > Waves > Wave templatesWarehouse management > Setup > Waves > Wave templates .

2. Select a template, such as 63 Container ization63 Container ization.

3. On the MethodsMethods  FastTab, move the Wave label pr intingWave label pr inting method to the Selected methodsSelected methods  column.

4. In the Selected methodsSelected methods  column, select the Wave label pr intingWave label pr inting method, and set its Wave step codeWave step code

field to PrintLabel. For more information about wave step codes, see Wave step codes.

1. Go to Warehouse management > Setup > Document routing > Wave label layoutsWarehouse management > Setup > Document routing > Wave label layouts .

2. Create a record that has the following settings:

Label layout ID:Label layout ID: Carton

Descr iption:Descr iption: Carton (SSCC)

3. On the Action Pane, select SaveSave.

4. On the Action Pane, select Wave label row settingsWave label row settings .

The Wave label row settingsWave label row settings  page appears. Here, you can configure the dynamic part of the label.

5. Add a row that has the following settings:

NOTENOTE

Row Id:Row Id: WorkLine

Row table name:Row table name: WHSWorkLine

Row star t position:Row star t position: 500

This field defines the vertical position where the row will begin on the label.

Row height:Row height: -50

This field defines the height of each row. The row height is positive for horizontal labels and

negative for vertical labels.

Rows per page:Rows per page: 5

This field defines the number of rows that can be printed on each label.

This setup will print several ZPL labels per work, where each page can hold up to five work lines. For

example, if a label is printed for a container that has 12 lines, three labels will be printed. If you want to

print a separate label for each pick line, set this value to 1.

6. Close the page.

7. On the Action Pane, select Edit quer yEdit quer y .

8. In the query editor dialog box, on the RangeRange tab, add a row that has the following settings:

Table:Table: Work lines

Derived table:Derived table: Work lines

Field:Field: Work type

Criter ia:Cr iter ia: Pick

9. If you want to be able to print the bill of lading ID, on the JoinsJoins  tab, select the Work linesWork lines  table, and join



Create a wave label templateCreate a wave label template

CT~~CD,~CC^~CT~
^XA
^LH10,10
^FO0,0 ^AT ^FD$WHSWorkTable.ContainerId$ ^FS
^FO0,75 ^AT ^FD$WHSWorkLine.ShipmentId$ ^FS
^FO0,150 ^AT ^FD$WHSShipmentTable.BillOfLadingId$ ^FS

<Row name="WorkLine">
<Heading>
//Optional heading for section of rows
</Heading>
^FO0,450 ^AT ^FDItem ^FS
^FO200,450 ^AT ^FDQuantity ^FS
^FO0,[[YPos]] ^AT ^FD$WHSWorkLine.ItemId$ ^FS
^FO200,[[YPos]] ^AT ^FD$WHSWorkLine.QtyWork$ ^FS
</Row>

^PQ1^XZ

NOTENOTE

the ShipmentsShipments  table to it.

10. Close the query editor dialog box.

11. The Pr inter text LayoutPrinter text Layout FastTab has three sections where you can write printer code: Header sectionHeader section,

Body sectionBody section, and Footer sectionFooter section. In the Header sectionHeader section section, in the Label headerLabel header  field, enter

code for the required header. For example, if you're using Zebra printers, you can use the following code.

12. In the Body sectionBody section section, in the Label bodyLabel body  field, enter ZPL code for the required body. Here is an

example.

13. In the Body sectionBody section section, in the Label footerLabel footer  field, enter ZPL code for the required footer. Here is an

example.

This setup will print one copy of each label. If you require more copies (for example, one copy for each side of the

pallet), set the nn value for the ^PQn^PQn section in the footer to the required number of copies. For example, to print

four copies of each label, specify ^PQ4^PQ4 .

Your label is now ready to use.

1. Go to Warehouse management > Setup > Document routing > Wave label templatesWarehouse management > Setup > Document routing > Wave label templates .

2. Add a wave level template, and set the following values in the header :

Label template name:Label template name: Container labels

Descr iption:Descr iption: Container labels

Wave step code:Wave step code: PrintLabel

Warehouse:Warehouse: 63

3. On the Wave label template detailsWave label template details  FastTab, add a row that has the following settings:

Label layout ID:Label layout ID: Container

Pr inter name:Pr inter name: Select an appropriate ZPL printer.

Run quer y:Run quer y: Yes (This setting is optional, but it's recommended for optimal performance.)



Configure number sequence extensionsConfigure number sequence extensions

Create a sales order and release it to the warehouseCreate a sales order and release it to the warehouse

4. On the Action Pane, select SaveSave.

5. Optional: If you're setting up a customer-specific label design, you must create a query to find the

customer's account. On the Wave label template detailsWave label template details  FastTab, select Edit quer yEdit quer y . Then, in the query

editor dialog box, on the RangeRange tab, add a row that has the following settings:

Table:Table: Shipments

Derived table:Derived table: Shipments

Field:Field: Account number

Criter ia:Cr iter ia: Enter the relevant customer account number.

When you've finished, select OKOK to close the query editor dialog box.

Number sequence extensions control the GS1 compliance of specific number sequences. This configuration is

optional for the current scenario. For more information and configuration instructions, see Configure number

sequence extensions.

NOTENOTE

1. Go to Sales and marketing > Sales order > All sales ordersSales and marketing > Sales order > All sales orders .

2. Create a sales order that has the following settings:

Customer account:Customer account: US-001

Warehouse:Warehouse: 63

3. Add five sales order lines:

Sales order line 1:

Item number :Item number : A0001

Quantity:Quantity: 10

Sales order line 2:

Item number :Item number : A0002

Quantity:Quantity: 20

Sales order line 3:

Item number :Item number : L0006

Quantity:Quantity: 20

Sales order line 4:

Item number :Item number : L0100

Quantity:Quantity: 40

Sales order line 5:

Item number :Item number : L0101

Quantity:Quantity: 50

The items and quantities that are provided here are only examples. They must have stock in the specified

warehouse.

4. Select sales order line 1. Then, in the Sales order lineSales order line section, on the Inventor yInventor y  menu, select

Reser vationsReser vations .



Scenario 3: Wave label printing for multi-tiered labels

Make demo data availableMake demo data available

Set up a wave process methodSet up a wave process method

Set up a wave templateSet up a wave template

5. On the Reser vationReser vation page, on the Action Pane, select Reser ve lotReser ve lot, and then close the page.

6. Repeat steps 4 and 5 for each additional sales order line.

7. On the Action Pane, on the WarehouseWarehouse tab, select Release to warehouseRelease to warehouse.

The following events occur :

The system processes the created shipment using the template that includes the label printing step.

The label layout will be used to define the format of the label, and the end result will be a label that

has five lines and that is printed on the printer that is selected in the label template.

A new bill of lading ID is generated for the shipments. If you configured the number sequence

extensions, the wave label IDs will follow the SSCC-18SSCC-18  number format.

You can reprint these wave labels by going to Warehouse management > Inquir ies and repor ts > WaveWarehouse management > Inquir ies and repor ts > Wave

label histor ylabel histor y .

This scenario shows how to use the wave label printing functionality when the warehousing processes require

several tiers of shipping labels. For example, separate labels might have to be printed for cartons and pallets,

and a break label might have to be printed for a whole shipment. Break labels are a separate type of label that

can be used as a divider between rolls and containers, such as labels for the shipment ID and a barcode, so that

the labels can easily be sorted after they are printed.

The main difference between the configuration of this scenario and the configuration of scenario 1, besides the

fact that break labels are enabled, is that multiple wave label types must be associated with wave label templates

and unit sequence group lines. To accomplish this configuration, you set up the following elements for this

scenario:

Wave processing methods:Wave processing methods: You will mark the wave label method as "repeatable," add it two (or more)

times to the wave template, and set different wave step codes.

Wave label templates:Wave label templates: You will configure the wave label templates and link them to the wave template.

Each wave label template has its own wave label type.

Wave label layouts:Wave label layouts: You will create multiple wave label layouts. There will be a separate label layout for

each "tier" of labels, and there will also be a break label layout.

This scenario shows the end-to-end flow.

To follow this scenario, you must have demo data installed, and you must select the USMFUSMF legal entity.

1. Go to Warehouse management > Setup > Waves > Wave process methodsWarehouse management > Setup > Waves > Wave process methods .

2. Confirm that waveLabelPr intingwaveLabelPr inting is in the list. If it isn't, select Regenerate methodsRegenerate methods  on the Action Pane to

add it.

3. For the waveLabelPr intingwaveLabelPr inting method, select the Make method repeatableMake method repeatable check box.

1. Go to Warehouse management > Setup > Waves > Wave templatesWarehouse management > Setup > Waves > Wave templates .

2. Select a template, such as 62 Shipping Default62 Shipping Default.

3. On the MethodsMethods  FastTab, move the Wave label pr intingWave label pr inting method to the Selected methodsSelected methods  column.

4. In the Selected methodsSelected methods  column, assign a Wave step codeWave step code value, such as Carton, to the Wave labelWave label

pr intingprinting method. For more information about wave step codes, see Wave step codes.

5. Move the Wave label pr intingWave label pr inting method to the Selected methodsSelected methods  column a second time.



Create three wave label layoutsCreate three wave label layouts

6. In the Selected methodsSelected methods  column, assign a different Wave step codeWave step code value, such as Pallet, to the second

Wave label pr intingWave label pr inting method. For more information about wave step codes, see Wave step codes.

1. Go to Warehouse management > Setup > Document routing > Wave label layoutsWarehouse management > Setup > Document routing > Wave label layouts .

2. Create a record that has the following settings:

Label layout ID:Label layout ID: Carton

Descr iption:Descr iption: Carton (SSCC)

3. On the Action Pane, select SaveSave.

4. On the Action Pane, select Wave label row settingsWave label row settings .

The Wave label row settingsWave label row settings  page appears. Here, you can configure the dynamic part of the label.

5. Add a row that has the following settings:

NOTENOTE

Row Id:Row Id: WaveLabel

Row table name:Row table name: WHSWaveLabel

Row star t position:Row star t position: 0

This field defines the vertical position where the row will begin on the label.

Row height:Row height: 0

This field defines the height of each row (in points), according to the ZPL standard. The row height

is positive for horizontal labels and negative for vertical labels. Because there is just one row in this

example, you can set the value to 0 (zero).

Rows per page:Rows per page: 1

This field defines the number of rows that can be printed on each label.

This setup will cause a separate ZPL label to be printed for each record in the wave labels table.

6. Close the page.

7. On the Action Pane, select Edit quer yEdit quer y .

8. In the query editor dialog box, on the RangeRange tab, add a row that has the following settings:

Table:Table: Work lines

Derived table:Derived table: Work lines

Field:Field: Work type

Criter ia:Cr iter ia: Pick

This query ensures that only pick-type work lines will be printed on the label, not put-type work lines.

9. If you want to be able to print the bill of lading ID, on the JoinsJoins  tab, select the Work linesWork lines  table, and join

the ShipmentsShipments  table to it.

10. Close the query editor dialog box.

11. The Pr inter text LayoutPrinter text Layout FastTab has three sections where you can write printer code: Header sectionHeader section,

Body sectionBody section, and Footer sectionFooter section. In the Header sectionHeader section section, in the Label headerLabel header  field, enter

code for the required header. For example, if you're using Zebra printers, you can use the following code.



CT~~CD,~CC^~CT~
^XA~TA000~JSN^LT0^MNW^MTT^PON^PMN^LH0,0^JMA^PR8,8~SD15^JUS^LRN^CI0^XZ
^XA
^MMT
^PW812
^LL1218
^LS0
^FT85,505^A0N,28,28^FH\^FD$WHSShipmentTable.CustomerReq$^FS
^FO1,173^GB809,0,1^FS
^FO0,391^GB809,0,1^FS
^FO3,599^GB809,0,2^FS
^FO420,176^GB0,216,1^FS
^FO313,3^GB0,169,1^FS
^FO0,807^GB809,0,1^FS
^FT529,370^A0N,28,26^FH\^FD$WHSShipmentTable.BillOfLadingId$^FS
^BY2,3,132^FT25,344^BCN,,N,N
^FD>:(420)>38102>63^FS
^FT526,315^A0N,28,28^FH\^FD ^FS
^FT437,248^A0N,28,28^FH\^FDCARR: $WHSShipmentTable.SCAC$^FS
^FT425,201^A0N,23,24^FH\^FDCARRIER:^FS
^FT17,68^A0N,20,19^FH\^FDIntershipping, Inc.^FS
^FT15,99^A0N,20,19^FH\^FD1000 Shipping Lane^FS
^FT16,158^A0N,20,19^FH\^FD ^FS
^FT438,368^A0N,28,28^FH\^FDB/L#^FS
^FT15,128^A0N,20,19^FH\^FDShelbyville TN 38102^FS
^FT19,203^A0N,23,24^FH\^FD(420) SHIP TO POSTAL CODE^FS
^FT331,39^A0N,28,28^FH\^FDShip To:^FS
^FT14,39^A0N,28,28^FH\^FDShip From:^FS
^FT331,67^A0N,23,24^FH\^FDWAL-MART DC 1111A-ABC DIS^FS
^FT330,98^A0N,23,24^FH\^FDDEPT 10^FS
^FT329,166^A0N,23,24^FH\^FDSpringfield TN 39021^FS
^FT330,134^A0N,23,24^FH\^FD100 Main Street^FS
^FT19,504^A0N,28,28^FH\^FDPO#:^FS
^FT437,316^A0N,28,28^FH\^FDPRO#^FS
^FT105,371^A0N,28,28^FB130,1,0,C^FH\^FD(420)39021^FS

<Row name="WaveLabel">
^FT127,439^A0N,28,28^FH\^FD$WHSWaveLabel.SeqNum$^FS
^FT256,439^A0N,28,28^FH\^FD$WHSWaveLabel.NumberOfLabels$^FS
^FT17,439^A0N,28,28^FH\^FDCARTON^FS
^FT522,422^A0N,23,24^FH\^FDVPN:^FS
^FT74,1156^A0N,28,28^FH\^FDSSCC-18^FS
^FT21,579^A0N,28,28^FH\^FDItem name:^FS
^FT107,580^A0N,28,28^FH\^FD$WHSWaveLabel.LabelItemName$^FS
^FT576,423^A0N,23,21^FH\^FD$WHSWaveLabel.LabelItemId$^FS
^FT252,1155^A0N,32,31^FH\^FD(00)$WHSWaveLabel.WaveLabelId$^FS
^BY4,3,283^FT66,1115^BCN,,N,N
^FD>;>800$WHSWaveLabel.WaveLabelId$^FS
^FT194,439^A0N,28,28^FH\^FDof^FS
</Row>

^PQ1^XZ

12. In the Body sectionBody section section, in the Label bodyLabel body  field, enter ZPL code for the required body. Here is an

example.

13. In the Body sectionBody section section, in the Label footerLabel footer  field, enter ZPL code for the required footer. Here is an

example.



NOTENOTE
This setup will print one copy of each label. If you require more copies (for example, one copy for each side of the

pallet), set the nn value for the ^PQn^PQn section in the footer to the required number of copies. For example, to print

four copies of each label, specify ^PQ4^PQ4 .

14. The first label is now ready to use.

15. Create a second layout record that has the following settings:

Label layout ID:Label layout ID: Pallet

Descr iption:Descr iption: Pallet

16. On the Action Pane, select SaveSave.

17. On the Action Pane, select Wave label row settingsWave label row settings .

The Wave label row settingsWave label row settings  page appears. Here, you can configure the dynamic part of the label.

18. Add a row that has the following settings:
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Row Id:Row Id: WaveLabel

Row table name:Row table name: WHSWaveLabel

Row star t position:Row star t position: 0

This field defines the vertical position where the row will begin on the label.

Row height:Row height: 0

This field defines the height of each row (in points), according to the ZPL standard. The row height

is positive for horizontal labels and negative for vertical labels. Because there is just one row in this

example, you can set the value to 0 (zero).

Rows per page:Rows per page: 1

This field defines the number of rows that can be printed on each label.

This setup causes a separate ZPL label to be printed for each record in the wave labels table.

19. Close the page.

20. On the Action Pane, select Edit quer yEdit quer y .

21. In the query editor dialog box, on the RangeRange tab, add a row that has the following settings:

Table:Table: Work lines

Derived table:Derived table: Work lines

Field:Field: Work type

Criter ia:Cr iter ia: Pick

This query ensures that only pick-type work lines will be printed on the label, not put-type work lines.

22. If you want to be able to print the bill of lading ID, on the JoinsJoins  tab, select the Work linesWork lines  table, and join

the ShipmentsShipments  table to it.

23. Close the query editor dialog box.



CT~~CD,~CC^~CT~
^XA
^LH10,10
^FO0,0 ^AT ^FD$WHSWaveLabel.WaveLabelId$ ^FS
^FO0,75 ^AT ^FD$WHSWorkLine.ShipmentId$ ^FS
^FO0,150 ^AT ^FD$WHSShipmentTable.BillOfLadingId$ ^FS

<Row name="WaveLabel">
^FO0,450 ^AT ^FDItem ^FS
^FO200,450 ^AT ^FDQuantity ^FS
^FO0,[[YPos]] ^AT ^FD$WHSWaveLabel.LabelItemId$ ^FS
^FO200,[[YPos]] ^AT ^FD$WHSWaveLabel.QtyWork$ ^FS
</Row>

^PQ1^XZ

NOTENOTE

CT~~CD,~CC^~CT~
^XA
^LH10,10
^FO0,0 ^AT ^FD$WHSWorkLine.ShipmentId$ ^FS

^XZ

24. The Pr inter text LayoutPrinter text Layout FastTab has three sections where you can write printer code: Header sectionHeader section,

Body sectionBody section, and Footer sectionFooter section. In the Header sectionHeader section section, in the Label headerLabel header  field, enter

code for the required header. For example, if you're using Zebra printers, you can use the following code.

25. In the Body sectionBody section section, in the Label bodyLabel body  field, enter ZPL code for the required body. Here is an

example.

26. In the Body sectionBody section section, in the Label footerLabel footer  field, enter ZPL code for the required footer. Here is an

example.

This setup will print one copy of each label. If you require more copies (for example, one copy for each side of the

pallet), set the nn value for the ^PQn^PQn section in the footer to the required number of copies. For example, to print

four copies of each label, specify ^PQ4^PQ4 .

27. The second label is now ready to use.

28. Create a third layout record that has the following settings:

Label layout ID:Label layout ID: Break

Descr iption:Descr iption: Break label

29. On the Action Pane, select SaveSave.

30. The Pr inter text LayoutPrinter text Layout FastTab has three sections where you can write printer code: Header sectionHeader section,

Body sectionBody section, and Footer sectionFooter section. In the Header sectionHeader section section, in the Label headerLabel header  field, enter ZPL

code for the required header. Here is an example.

31. This time, no body is required. Therefore, just enter the required text in the Footer sectionFooter section section. Here

is an example.



Create two wave label typesCreate two wave label types

Set up unit sequence groupsSet up unit sequence groups

Create wave label templatesCreate wave label templates
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The third label is now ready to use.

This third label is a break label that will be used as a divider between label rolls.

1. Go to Warehouse management > Setup > Document routing > Wave label typesWarehouse management > Setup > Document routing > Wave label types .

2. Create a record that has the following settings:

Label type:Label type: Carton

Descr iption:Descr iption: Carton

3. Create a second record that has the following settings:

Label type:Label type: Pallet

Descr iption:Descr iption: Pallet

1. Go to Warehouse management > Setup > Warehouse > Unit sequence groupsWarehouse management > Setup > Warehouse > Unit sequence groups .

2. Select or create an Ea Box PLEa Box PL  group.

3. For the BoxBox line, set the Wave level typeWave level type field to Carton.

4. For the PLPL  line, set the Wave level typeWave level type field to Pallet.

1. Go to Warehouse management > Setup > Document routing > Wave label templatesWarehouse management > Setup > Document routing > Wave label templates .

2. Create a label template that has the following settings:

Label template name:Label template name: Carton labels

Descr iption:Descr iption: Carton labels

Wave step code:Wave step code: Carton

Warehouse:Warehouse: 62

3. On the GeneralGeneral  FastTab, in the Wave label typeWave label type field, select a value, such as Carton.

4. On the Wave label template detailsWave label template details  FastTab, add a row that has the following settings:

Label layout ID:Label layout ID: Carton

Printer name:Pr inter name: Select an appropriate ZPL printer.

Run quer y:Run quer y: Yes (This setting is optional, but it's recommended for optimal performance.)

5. On the Action Pane, select SaveSave.

6. Optional: If you're setting up a customer-specific label design, you must create a query to find the

customer's account. On the Wave label template detailsWave label template details  FastTab, select Edit quer yEdit quer y . Then, in the query

editor dialog box, on the RangeRange tab, add a row that has the following settings:

Table:Table: Shipments

Derived table:Derived table: Shipments

Field:Field: Account number

Criter ia:Cr iter ia: Enter the relevant customer account number.

When you've finished, select OKOK to close the query editor dialog box.

7. On the Action Pane, select Edit quer yEdit quer y  to open the query editor dialog box for the whole label template.

8. In the query editor dialog box, on the Sor tingSor ting tab, add a row that has the following settings:



NOTENOTE

Table:Table: Work lines

Derived table:Derived table: Work lines

Field:Field: Reference load line id (Record-ID)

Search direction:Search direction: Ascending

9. Add a second row that has the following settings:

Table:Table: Work lines

Derived table:Derived table: Work lines

Field:Field: Shipment ID

Search direction:Search direction: Ascending

10. Select OKOK to close the query editor dialog box.

11. A message box prompts you to confirm the grouping reset operation. Select YesYes  to continue.

12. On the Action Pane, select Wave label template groupWave label template group.

13. In the Wave label template groupWave label template group dialog box, for the row where the Reference field nameReference field name field is

set to Shipment ID, set the following values:

Pr int break label:Pr int break label: Select this check box.

Label layout ID:Label layout ID: Select a break label. (For example, select the Break label layout that you created

earlier in this scenario.)

Pr inter name:Pr inter name: Select the printer for the break label. (Typically, for the purpose of splitting label rolls,

you should select the same printer that is selected on the Wave label template detailsWave label template details  FastTab.

However, other scenarios are possible.)

14. For the row where the Reference field nameReference field name field is set to Reference load line id, select the Label buildLabel build

IDID check box.

This setup will create one label sequence ("Carton 1 of X") per load line throughout the wave, regardless of the

work grouping setup. This label sequence can be printed on a label layout. Additionally, labels for different

shipments will be separated by the selected break label.

15. Select OKOK to close the Wave label template groupWave label template group dialog box.

16. Create a second label template that has the following settings:

Label template name:Label template name: Pallet labels

Descr iption:Descr iption: Pallet labels

Wave step code:Wave step code: Pallet

Warehouse:Warehouse: 62

17. On the GeneralGeneral  FastTab, in the Wave label typeWave label type field, select a value, such as Pallet.

18. On the Wave label template detailsWave label template details  FastTab, add a row that has the following settings:

Label layout ID:Label layout ID: Pallet

Pr inter name:Pr inter name: Select an appropriate ZPL printer.

Run quer y:Run quer y: Yes (This setting is optional, but it's recommended for optimal performance.)

19. On the Action Pane, select SaveSave.

20. Optional: If you're setting up a customer-specific label design, you must create a query to find the

customer's account. On the Wave label template detailsWave label template details  FastTab, select Edit quer yEdit quer y . Then, in the query

editor dialog box, on the RangeRange tab, add a row that has the following settings:



Configure number sequence extensionsConfigure number sequence extensions

Create a sales order and release it to the warehouseCreate a sales order and release it to the warehouse
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Table:Table: Shipments

Derived table:Derived table: Shipments

Field:Field: Account number

Criter ia:Cr iter ia: Enter the relevant customer account number.

When you've finished, select OKOK to close the query editor dialog box.

21. On the Action Pane, select Edit quer yEdit quer y  to open the query editor dialog box for the whole label template.

22. In the query editor dialog box, on the Sor tingSor ting tab, add a row that has the following settings:

Table:Table: Work lines

Derived table:Derived table: Work lines

Field:Field: Reference load line id (Record-ID)

Search direction:Search direction: Ascending

23. Add a second row that has the following settings:

Table:Table: Work lines

Derived table:Derived table: Work lines

Field:Field: Shipment ID

Search direction:Search direction: Ascending

24. Select OKOK to close the query editor dialog box.

25. A message box prompts you to confirm the grouping reset operation. Select YesYes  to continue.

26. On the Action Pane, select Wave label template groupWave label template group.

27. In the Wave label template groupWave label template group dialog box, for the row where the Reference field nameReference field name field is

set to Shipment ID, set the following values:

Pr int break label:Pr int break label: Select this check box.

Label layout ID:Label layout ID: Select a break label. (For example, select the Break label layout that you created

earlier in this scenario.)

Pr inter name:Pr inter name: Select the printer for the break label. (Typically, for the purpose of splitting label rolls,

you should select the same printer that is selected on the Wave label template detailsWave label template details  FastTab.

However, other scenarios are possible.)

28. For the row where the Reference field nameReference field name field is set to Reference load line id, select the Label buildLabel build

IDID check box.

This setup will create one label sequence ("Carton 1 of X") per load line throughout the wave, regardless of the

work grouping setup. This label sequence can be printed on a label layout. Additionally, labels for different

shipments will be separated by the selected break label.

Number sequence extensions control the GS1 compliance of specific number sequences. This configuration is

optional for the current scenario. For more information and configuration instructions, see Configure number

sequence extensions.

1. Go to Sales and marketing > Sales order > All sales ordersSales and marketing > Sales order > All sales orders .

2. Create a sales order that has the following settings:



NOTENOTE

Customer account:Customer account: US-001

Warehouse:Warehouse: 62

3. Add two sales order lines:

Sales order line 1:

Item number :Item number : A0001

Quantity:Quantity: 9024

Unit:Unit: ea (9024 ea = 376 Box = 47 PL)

Sales order line 2:

Item number :Item number : A0002

Quantity:Quantity: 9016

Unit:Unit: ea (9016 ea = 322 Box = 46 PL)

The items and quantities that are provided here are only examples. They must use the unit sequence group that

you defined earlier, appropriate unit conversions from ea to Box to PL must be defined for them, and they must

have stock in warehouse 62. For more information, see Unit of measure and stocking policies.

4. Select sales order line 1. Then, in the Sales order lineSales order line section, on the Inventor yInventor y  menu, select

Reser vationsReser vations .

5. On the Reser vationReser vation page, on the Action Pane, select Reser ve lotReser ve lot, and then close the page.

6. Repeat steps 4 and 5 for sales order line 2.

7. On the Action Pane, on the WarehouseWarehouse tab, select Release to warehouseRelease to warehouse.

The following events occur :

The system processes the created shipment by using the template that includes the label printing step.

The label layout will be used to define the format of the label, and the result will be a label that is

printed on the printer that is selected in the label template.

Wave labels are generated and printed. The number of labels will equal the number of cartons (in this

example, 376 Box labels for line 1, 322 Box labels for line 2, 47 PL labels for line 1, 47 PL labels for line

2, and two break labels that have the shipment ID).

A new bill of lading ID is generated for the shipments. If you configured the number sequence

extensions, the wave label IDs will follow the SSCC-18SSCC-18  number format.

You can view and reprint wave labels from the following pages:

All shipments > Shipment details

All loads > Load details

All waves

Wave labels

Wave label history

For most of these pages, you can find the relevant function by selecting Wave labelsWave labels  in the RelatedRelated

informationinformation group on the ShipmentsShipments  tab of the Action Pane.
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Main elements of the functionality

Scenarios

The auto-update shipment functionality automatically updates quantities (both increases and decreases) on a

load line that is associated with a shipment, after the load has been released to a warehouse. This functionality

remains turned on until the load line on the shipment or load is processed on a wave. When it's used, order

updates can automatically flow through to the warehouse, without requiring manual intervention, until

warehouse work is created.

When the auto-update shipment functionality isn't used, only quantity decreases automatically flow until

warehouse work is created. Users must manually update or delete lines, and they must then re-release lines if

order quantities are increased or new order lines are added. By using the auto-update shipment functionality,

businesses can seamlessly provide updates to the warehouse without having to worry that related shipments

and loads won't reflect order line updates.

The auto-update shipment functionality applies to both sales order lines and transfer order lines, and it's turned

on for a specific warehouse. Therefore, companies can apply different auto-update shipment policies across

warehouses, as they require. By default, the auto-update shipment policy for quantity decreases is applied for all

warehouses that use warehouse management processes. When this default policy setting is used, only quantity

decreases automatically flow through to a shipment and load until warehouse work is created. This behavior

resembles the behavior that was used before the auto-update shipment functionality was introduced.

The auto-update shipment functionality relies primarily on the shipment status to determine whether the

quantity on a load line should be changed when a change is made on a sales order line or transfer order line. It

also relies primarily on the shipment status to determine when a new load line should automatically be added to

an existing load. When the shipment status is WavedWaved or higher, no automatic update occurs.

Wave status is also considered for automatic updates. When the wave that is related to the load line has a status

of HeldHeld, ExecutingExecuting, ReleasedReleased, PickedPicked, or ShippedShipped, if a user tries to reduce the quantity on a load line (via a

quantity decrease on the sales order line or transfer order line), the following error message is shown:

"Reservations cannot be removed because there is work created which relies on the reservations." Additionally,

when the wave has one of the previously mentioned wave statuses, if a user tries to indirectly increase the load

line quantity by increasing the quantity on the sales order line or transfer order line, the quantity on the load line

isn't automatically increased. In this case, the load line must be manually updated.

The auto-update shipment functionality supports four scenarios: adding a new order line, increasing the

quantity on an order line, decreasing the quantity on an order line, and removing an order line.

Add a new order lineAdd a new order line – When the Auto update shipmentAuto update shipment field on the WarehouseWarehouse FastTab of the

WarehousesWarehouses  page (Warehouse management > Setup > Warehouse > WarehousesWarehouse management > Setup > Warehouse > Warehouses ) is set to AlwaysAlways ,

if a shipment exists for the order, and a new order line is added to a sales order or transfer order after a load

has already been created for the sales order, the existing load isn't updated. A new load line that has no

reference to the existing load is created and associated with the existing shipment. The new line is added to

the load and released.

Increase the quantity on an order lineIncrease the quantity on an order line – When the Auto update shipmentAuto update shipment field is set to AlwaysAlways , if a

shipment exists for the order, and the quantity on an existing sales order line or transfer order line is

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/auto-update-shipment.md


Example scenario

Turn on the auto-update shipment functionalityTurn on the auto-update shipment functionality

Change the wave template so that load lines aren't automatically processedChange the wave template so that load lines aren't automatically processed

Create a sales orderCreate a sales order

increased after a load has already been created for the sales order, the load line is increased by the same

quantity as the order line. If the load was released, but no work was created, the load line is increased by the

same quantity as the order line.

Decrease the quantity on an order lineDecrease the quantity on an order line – When the Auto update shipmentAuto update shipment field is set to AlwaysAlways  or

On quantity decreaseOn quantity decrease, if a shipment exists for the order, and the quantity on an existing sales order line or

transfer order line is decreased after a load has already been created for the sales order, the quantity on the

associated load line is updated to match, unless the quantity on that load line already equals or is less than

the new quantity on the order line. In that case, the load line isn't affected. If the load was released, but no

work was created, the quantity on the associated load line is updated to match, unless the quantity on the

load line already equals or is less than the new quantity on the order line. In that case, the load line is

affected.

Remove an order lineRemove an order line – When the Auto update shipmentAuto update shipment field is set to AlwaysAlways  or On quantityOn quantity

decreasedecrease, if the user tries to remove an order line that a load line exists for, an error message is shown.

For this scenario, you must have demo data installed, and you must use the USMFUSMF demo data company.

To turn on the auto-update shipment functionality, follow these steps.

1. Go to Warehouse management > Setup > Warehouse > WarehousesWarehouse management > Setup > Warehouse > Warehouses .

2. Select warehouse 2424 .

3. On the WarehouseWarehouse FastTab, in the Auto update shipmentAuto update shipment field, change the value from On quantityOn quantity

decreasedecrease to AlwaysAlways .

After you change the value to AlwaysAlways , any increases or decreases in the quantities on sales order lines and

transfer order lines, and any additions of new lines, are reflected on shipments and loads for the selected

warehouse, given the previously mentioned update constraints.

To configure the wave template so that it doesn't automatically process load lines, follow these steps.

1. Go to Warehouse management > Setup > Waves > Wave templatesWarehouse management > Setup > Waves > Wave templates .

2. Select wave template 24 Shipping default24 Shipping default.

3. Select EditEdit.

4. On the GeneralGeneral  FastTab, set the Automate wave creationAutomate wave creation option to YesYes , and make sure that all other

options are set to NoNo.

It's important that no work be automatically created and released as part of the wave creation process. After

work is created that is related to the load line that was created for the sales order line, the load line is no longer

automatically updated if the quantity on the sales order line is changed.

To create a sales order, follow these steps.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. Select customer US-003US-003 .

3. Create a line for item number A0001A0001 .

4. Enter a quantity of 1010 . (Make sure that you're using warehouse 2424 .)

5. Select SaveSave.

6. On the Action Pane, on the WarehouseWarehouse tab, in the ActionsActions  group, select Release to warehouseRelease to warehouse. A

shipment and a wave are created.



Decrease the quantity on a sales order lineDecrease the quantity on a sales order line

Increase the quantity on a sales order lineIncrease the quantity on a sales order line

NOTENOTE

Add a sales order lineAdd a sales order line

Process a waveProcess a wave

Because you changed the wave template in the previous procedure, no load or work is created. The shipment

status is OpenOpen, and the wave status is CreatedCreated.

To decrease the quantity on a sales order line, follow these steps.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. Select the sales order that you just released to the warehouse.

3. Select the sales order line. In the QuantityQuantity  field, change the value from 1010  to 88 .

4. From the sales order line, select Warehouse > Shipment detailsWarehouse > Shipment details . On the Shipment detailsShipment details  page, on the

Load linesLoad lines  FastTab, the quantity reflects the change on the sales order line.

To increase the quantity on a sales order line, follow these steps.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. Select the sales order that you previously released to the warehouse.

3. Change the line quantity from 88  to 1212 .

4. Select SaveSave.

5. Go back to the All sales ordersAll sales orders  page, and select the sales order again.

6. On the Action Pane, on the WarehouseWarehouse tab, in the Related informationRelated information group, select Shipment detailsShipment details .

On the Shipment detailsShipment details  page, on the Load linesLoad lines  FastTab, the quantity reflects the change on the sales

order line.

Although the quantity on the load line was increased from 8 to 12, only eight items remain reserved, unless

automatic reservation is turned on. Because the quantity that was added to the existing shipment hasn't been

reserved, if the wave is processed at this point, without reservation, work is created only for the quantity that

has already been reserved.

When the quantity on an order line is decreased, the quantity on the load line isn't affected if it already equals or is less

than the new quantity on the order line. When the quantity on an order line is increased, the load line is increased by the

same quantity as the order line. If the quantity on the order line differs from the quantity on the load line, the difference

remains.

To add a sales order line, follow these steps.

1. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

2. Select the sales order that you previously released to the warehouse.

3. Create a line for item number A0002A0002 .

4. In the QuantityQuantity  field, enter 1010 . (Make sure that you're using warehouse 2424 .) The new line is automatically

added to the existing shipment.

5. Select SaveSave.

6. Go back to the All sales ordersAll sales orders  page, and select the sales order again.

7. On the Action Pane, on the WarehouseWarehouse tab, in the Related informationRelated information group, select Shipment detailsShipment details .

On the Shipment detailsShipment details  page, on the Load linesLoad lines  FastTab, notice the second load line.

Because the sales order line that you just added to the existing shipment hasn't been reserved, if the wave is

processed at this point, work is created only for the quantity on the first sales order line and the first load line.



NOTENOTE

To process the wave, follow these steps.

1. Go to Warehouse management > Outbound waves > Shipment waves > All wavesWarehouse management > Outbound waves > Shipment waves > All waves .

2. Select the wave that you previously created.

3. On the Action Pane, on the WaveWave tab, in the WaveWave group, select ProcessProcess .

The wave is processed and creates work for the reserved quantities on the load lines. The shipment status is

updated from OpenOpen to WavedWaved. As the shipment status is updated to WavedWaved, any changes that occur, such as

decreases or increases in line quantities, or the addition of new lines to the sales order, don't affect the existing

load lines that are associated with the waved shipment.

If a shipment has a status of WavedWaved or higher, updates to the quantity on a sales order line aren't reflected on or

validated against a load line that is associated with the shipment. Changes to the quantity on a load line must be

made directly on the load line.

Validation is done after work has been created for the load line and a reservation has been made. A decrease in

the quantity on the sales order line is then validated against the work line reservation.
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NOTENOTE

This topic explains how to create a location profile in Dynamics 365 Supply Chain Management. Every location

in the warehouse needs to have a location profile associated with it that describes the properties of the location,

for example, whether the location allows mixed items. In this procedure we'll create a profile for a location that

doesn't require license plate control. We'll enable mixed items, and mixed inventory statuses, and allow cycle

counting. You can use this procedure in the USMF demo data company.

1. In the navigation pane, go to Modules > Warehouse management > Setup > Warehouse > LocationModules > Warehouse management > Setup > Warehouse > Location

profilesprofiles .

2. Select NewNew .

3. In the Location profile IDLocation profile ID field, type a value.

4. In the NameName field, type a value.

5. In the Location formatLocation format field, enter or select a value.

6. In the Location typeLocation type field, enter or select a value.

7. In the Dock management profile IDDock management profile ID field, enter or select a value.

8. Select YesYes  in the Allow mixed itemsAllow mixed items field.

9. Select YesYes  in the Allow mixed inventor y statusesAllow mixed inventor y statuses  field.

10. Select YesYes  in the Allow cycle countingAllow cycle counting field.

11. Select SaveSave.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Configure locations in a WMS-enabled warehouse
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Create a new warehouse

Define a location format

This guide shows you how to configure the location setup for a new WMS-enabled warehouse (a warehouse

that uses advanced warehouse management processes). The process is typically done by a warehouse manager.

You can run this guide in demo data company USMF or on your own data. A precondition is that you have at

least one site configured.

1. Go to Navigation pane > Modules > Inventor y management > Setup > Inventor y breakdown >Navigation pane > Modules > Inventor y management > Setup > Inventor y breakdown >

WarehousesWarehouses .

2. Click NewNew .

3. In the WarehouseWarehouse field, type a value.

4. In the NameName field, type a value.

5. In the S iteSite field, type a value.

6. Expand the WarehouseWarehouse section.

7. Set the Use warehouse management processes optionUse warehouse management processes option to Yes. This setting allows you to run advanced

warehousing processes using warehouse work and mobile devices.

8. Close the page.

1. Go to Navigation pane > Modules > Warehouse management > Setup > Warehouse >LocationNavigation pane > Modules > Warehouse management > Setup > Warehouse >Location

formatsformats . Location formats are a naming-system used to create unique and consistent names for the

different location bin positions used within a warehouse. It can be useful to use separators as part of the

location format to make it easier to identify components of the location such as the aisle number. In this

example, we'll create a name with four components. For example, these could be aisle, rack, shelf, and bin.

2. Click NewNew .

3. In the Location formatLocation format field, type a value.

4. In the NameName field, type a value.

5. In the Segment descr iptionSegment descr iption field, type a value. This describes what the first component of the location

name represents. For example, it could be 'Aisle'.

6. In the LengthLength field, enter a number. This determines how many characters this part of the location name

must have. Note that the total of all components in the name, including the separators, cannot exceed 10

characters.

7. In the SeparatorSeparator  field, type a value. This determines which character or symbol is used between the first and

second component of the name.

8. In the DetailsDetails  section, click NewNew .

9. In the Segment descr iptionSegment descr iption field, type a value.

10. In the LengthLength field, enter a number.

11. In the SeparatorSeparator  field, type a value.

12. In the DetailsDetails  section, click NewNew .

13. In the Segment descr iptionSegment descr iption field, type a value.

14. In the LengthLength field, enter a number.

15. In the SeparatorSeparator  field, type a value.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/tasks/configure-locations-wms-enabled-warehouse.md


Define location types

Define location profile

Enable warehouse management parameters

16. In the DetailsDetails  section, click NewNew .

17. In the Segment descr iptionSegment descr iption field, type a value.

18. In the LengthLength field, enter a number.

19. Click SaveSave.

20. Close the page.

1. Go to Navigation pane > Modules > Warehouse management > setup > Warehouse > LocationNavigation pane > Modules > Warehouse management > setup > Warehouse > Location

typestypes . Location types can be used as filtering options to control the different warehouse management

processes. As a minimum, you need to create staging and final shipping location types in order to define the

outbound warehouse management process.

2. Click NewNew .

3. In the LocationLocation type field, type a value.

4. In the Descr iptionDescr iption field, type a value.

5. Close the page.

1. Go to Navigation pane > modules > Warehouse management > Setup > Warehouse > LocationNavigation pane > modules > Warehouse management > Setup > Warehouse > Location

profilesprofiles . The definition of location profiles is very important. Grouped locations capacity can be controlled

here, as well as the policies related to what inventory gets stored, and how it is stored. Location profiles can

be used as filtering options to control the different warehouse management processes. As a minimum, you

must create a user location profile in order to enable the warehouse management processes.

2. Click NewNew .

3. In the Location profile IDLocation profile ID field, type a value.

4. In the NameName field, type a value.

5. In the Location formatLocation format field, click the drop-down button to open the lookup.

6. In the list, find and select the desired record.

7. In the list, click the link in the selected row.

8. In the Location typeLocation type field, click the drop-down button to open the lookup.

9. In the list, find and select the desired record.

10. In the list, click the link in the selected row.

11. Select or clear the Allow mixed inventor y statusesAllow mixed inventor y statuses  check box. Enable this option if you want to allow

mixed inventory status values in the locations that are going to be grouped by this location profile.

12. Select or clear the Overr ide rules for batch daysOverr ide rules for batch days  check box. Enable this option to override the rule for

how many days the inventory batch expiration dates can differ, to allow mixing of inventory batches that

don't obeying this rule.

13. Select or clear the Allow cycle countingAllow cycle counting check box. Enable this option to allow cycle counting processing in

all the locations that are going to be grouped by this location profile.

14. Expand or collapse the DimensionsDimensions  section. The Dimensions tab allows you to define parameters and

methods to enable precise calculations of the load capacity within each of the locations.

15. Close the page.

1. Go to Navigation pane > Modules > Warehouse management > Setup > WarehouseNavigation pane > Modules > Warehouse management > Setup > Warehouse

management parametersmanagement parameters . To be able to process warehouse work, you need to set parameters for the user

location profile the staging location type, and the final shipping location type As soon as the outbound

process ends at the final shipping location type that you define, the related outbound transactions will be



Define warehouse zone groups

Define Warehouse zones

Create locations using the Location setup wizard

updated to "Picked".

2. Expand the Location profilesLocation profiles  section.

3. In the User locationUser location field, click the drop-down button to open the lookup.

4. In the list, click the link in the selected row.

5. Expand the Location typesLocation types  section.

6. In the Staging location typeStaging location type field, click the drop-down button to open the lookup.

7. In the list, click the link in the selected row.

8. In the Final shipping location typeFinal shipping location type field, click the drop-down button to open the lookup.

9. In the list, click the link in the selected row.

10. Close the page.

1. Go to Navigation pane > Modules > Warehouse management > Setup > Warehouse >Navigation pane > Modules > Warehouse management > Setup > Warehouse >

Warehouse zone groupsWarehouse zone groups . Warehouse zones can be used as filters for options to control the different

warehouse management processes. You need to create a zone group before you can define a zone.

2. Click NewNew .

3. In the Zone group IDZone group ID field, type a value.

4. In the Zone group nameZone group name field, type a value.

5. Close the page.

1. Go to Navigation pane > Modules > Warehouse management > Setup > Warehouse > ZonesNavigation pane > Modules > Warehouse management > Setup > Warehouse > Zones .

2. Click NewNew .

3. In the Zone IDZone ID field, type a value.

4. In the Zone nameZone name field, type a value.

5. In the Zone group IDZone group ID field, click the drop-down button to open the lookup.

6. In the list, find and select the desired record.

7. In the list, click the link in the selected row.

8. Close the page.

1. Go to Navigation pane > Modules > Warehouse management > Setup > Warehouse > LocationNavigation pane > Modules > Warehouse management > Setup > Warehouse > Location

setup wizardsetup wizard.

2. In the WarehouseWarehouse field, click the drop-down button to open the lookup.

3. In the list, find and select the desired record.

4. In the list, click the link in the selected row.

5. In the Zone IDZone ID field, click the drop-down button to open the lookup.

6. In the list, find and select the desired record.

7. In the list, click the link in the selected row.

8. In the Location profile IDLocation profile ID field, click the drop-down button to open the lookup.

9. In the list, find and select the desired record.

10. In the list, click the link in the selected row.

11. In the list, mark the selected row.

12. In the From numberFrom number  field, enter a number. The From number and To number fields define how many

locations will be created. For example, if you set From number to 1 and To number to 3 for all four lines in

the location format, 81 locations will be created (3x3x3x3).



Create locations manually

Define Pack size categories

Define location stocking limits

Define fixed picking locations

13. In the To numberTo number  field, enter a number.

14. In the list, find and select the desired record.

15. In the From numberFrom number  field, enter a number.

16. In the To numberTo number  field, enter a number.

17. In the list, find and select the desired record.

18. In the From numberFrom number  field, enter a number.

19. In the To numberTo number  field, enter a number.

20. In the list, find and select the desired record.

21. In the From numberFrom number  field, enter a number.

22. In the To numberTo number  field, enter a number.

23. Click Create.

1. Go to Warehouse management > Setup > Warehouse > LocationsWarehouse management > Setup > Warehouse > Locations . Manually creation of locations

within a warehouse can easily be done. The location name and the location profile ID are mandatory values.

2. Click NewNew .

3. In the WarehouseWarehouse field, type a value.

4. In the LocationLocation field, type a value. Note that you're creating a new location here, so you need to type a new

unique name, rather than selecting an existing one.

5. In the Location profile IDLocation profile ID field, type a value.

6. Close the page.

1. Go to Warehouse management > Setup > Warehouse > Pack size categoriesWarehouse management > Setup > Warehouse > Pack size categories . Pack size categories

can be used to group items that have similar physical packing sizes. In this example the pack size category

will be used to control the capacity at the picking locations within a specific zone of the warehouse. Please

note that the pack size category ID must be assigned to the released product entity in order to be used as

part of the stocking limits processing.

2. Click NewNew .

3. In the Pack size categor y IDPack size categor y ID field, type a value.

4. In the Pack size categor y namePack size categor y name field, type a value.

5. Close the page.

1. Go to Warehouse management > Setup > Warehouse > Location stocking limitsWarehouse management > Setup > Warehouse > Location stocking limits . Location stocking

limits help to make sure that work isn't created to request that inventory to be put in a location that doesn't

have the physical capacity to carry the inventory.

2. Click NewNew .

3. In the WarehouseWarehouse field, type a value.

4. In the Location profile IDLocation profile ID field, type a value.

5. In the Pack size categor y IDPack size categor y ID field, type a value.

6. In the QuantityQuantity  field, enter a number.

7. Click SaveSave.

8. Close the page.



NOTENOTE

1. Go to Warehouse management > Setup > Warehouse > Fixed locationsWarehouse management > Setup > Warehouse > Fixed locations . You can define the locations

to be used per product or per product variant. It is possible to create multiple fixed locations for the same

product within the same warehouse.

2. Click NewNew .

3. In the Item numberItem number  field, type a value.

4. In the WarehouseWarehouse field, type a value.

5. In the LocationLocation field, click the drop-down button to open the lookup.

6. In the list, click the link in the selected row.

7. Close the page.
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Turn on the Warehouse location status feature

Set up warehouse location status
Prepare the sample data that is required for the example scenarioPrepare the sample data that is required for the example scenario

Use the USMF legal entityUse the USMF legal entity

Set up location profilesSet up location profiles

Microsoft Dynamics 365 Supply Chain Management includes several location fields that give you flexibility

when you work with and maintain locations. You can include location statuses in the location directive query to

provide better control over warehouse flow.

The following four fields on the LocationsLocations  page track information about the current status of a location. These

fields let warehouse managers get an overview of the status of the warehouse locations. They also allow for

advanced reporting and filtering.

Item numberItem number  – The item that is currently in the location. If the location contains multiple items, this field

is blank.

Last activity date and timeLast activity date and time – The timestamp of the last warehouse transaction that was performed

against the location.

Aging dateAging date – The date when the inventory in the location was brought into the warehouse. This value is

calculated based on the aging date of the license plate. It's accurate for locations that are license plate–

tracked, but it might not be accurate for locations that aren't license plate–tracked.

Location statusLocation status  – The status of the location. There are four possible values:

UndeterminedUndetermined – The location profile can't track status. Therefore, the current status is unknown.

EmptyEmpty  – There is currently no inventory in the location.

PickingPicking – Outbound transactions have been performed against the location since it was last empty.

StorageStorage – Only inbound transactions have been performed against the location since the location was

last empty.

Before you can use the Warehouse location status feature, it must be turned on in your system. Admins can use

the feature management settings to check the status of the feature and turn it on if it's required. In the FeatureFeature

managementmanagement workspace, the feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Warehouse location status

Before you start to work through the scenario, you must activate sample data and set up the feature as

described in this section. To complete the example scenario, you must use either the warehouse app or the

browser-based emulator. The steps that are provided here use the warehouse app. The steps for the browser-

based emulator are similar.

To work through the example scenario by using the sample records and values that are specified here, you must

be on a system where the standard demo data is installed. Additionally, you must select the USMFUSMF legal entity

before you begin.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/warehouse-location-status.md
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ScenarioScenario

The example scenario requires that you prepare two location profiles.

1. Go to Warehouse management > Setup > Warehouse > Location profilesWarehouse management > Setup > Warehouse > Location profiles .

2. Select EditEdit to put the page into edit mode.

3. Select the BULK-06BULK-06  profile.

4. On the GeneralGeneral  FastTab, set the following values:

Enable item in location:Enable item in location: Set this option to Yes.

Enable location activity date and time:Enable location activity date and time: Set this option to Yes.

Enable location status:Enable location status: Set this option to Yes.

These options control whether the reference fields on the location are active.

5. Repeat steps 3 through 4 for the PICK-06PICK-06  profile.

When the parameters on the location profile (Enable item in locationEnable item in location, Enable location activityEnable location activity , Enable locationEnable location

statusstatus) are set to Yes, the system immediately updates the relevant locations by executing the warehouse location status

consistency check job.

1. Go to Procurement and sourcing > Purchase orders > All purchase ordersProcurement and sourcing > Purchase orders > All purchase orders .

2. Select NewNew .

3. In the Create purchase orderCreate purchase order  dialog box, on the VendorVendor  FastTab, in the Vendor accountVendor account field, select

104.

4. On the GeneralGeneral  FastTab, in the WarehouseWarehouse field, select 61.

5. Select OKOK.

6. Your new purchase order (PO) is opened. It includes an empty line in the Purchase order linesPurchase order lines  grid. On

this line, set the following values:

Item number :Item number : A0002

Quantity:Quantity: 5

7. On the Action Pane, on the PurchasePurchase tab, in the ActionsActions  group, select ConfirmConfirm to confirm the purchase

order.

8. On the mobile device, go to Inbound > Purchase ReceiveInbound > Purchase Receive.

9. Select the PONUMPONUM field, enter the PO number, and confirm.

10. Select the ITEMITEM field, enter A0002 as the item number, and confirm.

11. On the QTYQTY page, enter 5 as the quantity, and confirm.

You can enter the quantity in either of the following ways:

Select the plus sign (++) or minus sign (––) button to add or subtract a numerical value.

Select the blank field between the plus sign (++) and minus sign (––) buttons to open the number pad.

12. Confirm your selection of item number A0002 and a quantity of 5. A "Work Completed" message

appears at the bottom of the page.

13. Select the Menu button (sometimes referred to as the hamburger or the hamburger button) in the upper-



right corner, and then select CancelCancel  to exit Purchase ReceivePurchase Receive and return to the InboundInbound menu.

14. On the purchase order page, select Work detailsWork details  above the Purchase order linesPurchase order lines  grid.

15. On the GeneralGeneral  tab, notice the Work IDWork ID and Target license plate IDTarget license plate ID values that were created.

16. In the L inesLines  section, notice the LocationLocation values for the Pick and Put work types.

17. On the mobile device, go to Inbound > Purchase Put-awayInbound > Purchase Put-away .

18. Select the IDID field, enter the work ID, and confirm.

19. Confirm once more to complete the Pick entry.

20. Select the Menu button in the upper-right corner, and then select DoneDone to complete the Pick work.

21. Make a note of the Putaway location, and confirm. A "Work Completed" message appears at the bottom

of the page.

22. Select the Menu button in the upper-right corner, and then select CancelCancel  to exit Purchase Put-awayPurchase Put-away

and return to the InboundInbound menu.

23. Select BackBack to return to the main menu.

24. In Dynamics 365 Supply Chain Management, go to Warehouse management > Setup > WarehouseWarehouse management > Setup > Warehouse

> Locations> Locations .

25. Filter on LocationLocation, and enter the putaway location from the purchase order work. You should see the

following results:

The Location statusLocation status  column shows a value of Storage, because the last transaction against this

location was a put.

The Item numberItem number  column shows a value of A0002, because that item was received and put to the

location.

The Last activity date and timeLast activity date and time column shows the timestamp for the date and time when the work

was completed at the location.

26. On the mobile device, go to Quality > MovementQuality > Movement.

27. Select the LOC/LPLOC/LP field, and enter the location you made note of in the previous steps.

28. Confirm the information that is shown. Make a note of the license plate number that is generated.

29. On the To InformationTo Information screen, select the LOC/LPLOC/LP field, and enter 06A07R2S1B as the location to move

the item to.

30. On the To InformationTo Information screen, confirm the LPLP value (the target license plate ID), which is automatically

generated. A "Work Completed" message appears at the bottom of the page.

31. Select the Menu button in the upper-right corner, and then select CancelCancel  to exit MovementMovement and return

to the Quality ManagementQuality Management menu.

32. Select BackBack to return to the main menu.

33. In Dynamics 365 Supply Chain Management, go to Warehouse management > Setup > WarehouseWarehouse management > Setup > Warehouse

> Locations> Locations .

34. Refresh the LocationsLocations  page, and view the original putaway location again. Notice that the LocationLocation

statusstatus  field is now set to Empty, and the Item numberItem number  column is blank.

35. View the record for location 06A07R2S1B, and notice that the StatusStatus  value has changed to Storage, and

the Item numberItem number  and Last activity date and timeLast activity date and time fields have been updated.



36. Go to Sales and marketing > Sales orders > All sales ordersSales and marketing > Sales orders > All sales orders .

37. Select NewNew .

38. In the Create sales orderCreate sales order  dialog box, in the Customer accountCustomer account field, select US-002.

39. In the WarehouseWarehouse field, select 61.

40. Select OKOK.

41. Your new sales order is opened. It includes an empty line in the Sales order linesSales order lines  grid. On this line, set

the following values:

Item number :Item number : A0002

Quantity:Quantity: 1

42. On the Sales order linesSales order lines  FastTab, on the Inventor yInventor y  menu, select Reser vationReser vation.

43. On the Reser vationReser vation page, select Reser ve lotReser ve lot to reserve the order line. Then select the CloseClose button (XX)

in the upper-right corner to close the page.

44. On the Action Pane, on the WarehouseWarehouse tab, in the ActionsActions  group, select Release to warehouseRelease to warehouse.

45. In the Sales order linesSales order lines  section, on the WarehouseWarehouse menu, select Work detailsWork details .

46. Copy the Work IDWork ID value that was created.

47. On the mobile device, go to Outbound > Sales pickingOutbound > Sales picking.

48. Select the IDID field, enter the work ID that you copied earlier, and confirm.

49. On the Sales orders: PickSales orders: Pick  page, the LOCLOC field suggests the picking location as the putaway location that

was created earlier. Make a note of the location.

50. Select the LOCLOC field, enter the location, and confirm.

51. Select the LPLP field, enter the license plate number that you made a note of during the Movement activity,

and confirm.

52. Select the ItemItem field, enter the A0002 as the item number, and confirm.

53. On the QTYQTY page, enter 1 as the quantity, and confirm.

You can enter the quantity in either of the following ways:

Select the plus sign (++) or minus sign (––) button to add or subtract a numerical value.

Select the blank field between the plus sign (++) and minus sign (––) buttons to open the number pad.

54. Select the TARGET LPTARGET LP field, enter a user-defined target license plate ID, and confirm.

55. Confirm once more to complete the picking work. A "Work Completed" message appears at the bottom

of the page.

56. Select the Menu button in the upper-right corner, and then select CancelCancel  to complete the picking activity

and return to the OutboundOutbound menu.

57. In Dynamics 365 Supply Chain Management, go to Warehouse management > Setup > WarehouseWarehouse management > Setup > Warehouse

> Locations> Locations .

58. Filter on LocationLocation, and enter the pick location from the sales order work.

59. Notice that the Location statusLocation status  field for the location that the sales order work picked from is now set to

Picking, and the Last activity date and timeLast activity date and time field has been updated.



NOTENOTE

NOTENOTE

The location fields are updated only by warehouse transactions. If you move inventory by using a journal or other non-

WHS processes, the fields won't be updated.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Additional location zones
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Turn on the Additional location zone feature

Use location zones

NOTENOTE

Three new zone fields are available in Microsoft Dynamics 365 Supply Chain Management. Warehouse

managers can use them to define additional warehouse organizations or layouts. The new zone fields can be set

either manually or by using the Location setupLocation setup wizard. They can be used in any query or filtering that uses the

Locations table.

No additional setup is required to use the zone fields.

Before you can use the Additional location zone feature, it must be turned on in your system. Admins can use

the feature management settings to check the status of the feature and turn it on if it's required. In the FeatureFeature

managementmanagement workspace, the feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Additional location zone

1. Go to Warehouse management > Setup > Warehouse > Location setup wizardWarehouse management > Setup > Warehouse > Location setup wizard.

2. Set the following values:

In the WarehouseWarehouse field, select 62.

In the Zone IDZone ID field, select FLOOR.

In the Additional Zone 1Additional Zone 1  field, select PICKZONE1.

In the Additional Zone 2Additional Zone 2  field, select WEBSHOP1.

In the Location profile IDLocation profile ID field, select FLOOR.

3. Select the FloorFloor  line.

4. In the From numberFrom number  field, enter 1. In the To numberTo number  field, enter 3.

5. Select the AisleAisle line.

6. In the From numberFrom number  field, enter 1. In the To numberTo number  field, enter 5.

7. Select CreateCreate.

8. You receive messages that state that new locations have been added. Select the Show messagesShow messages  button

to view the messages.

9. Go to Warehouse management > Setup > Warehouse > LocationsWarehouse management > Setup > Warehouse > Locations . The new locations appear in

the list, and all zone fields are available (that is, the existing zone field and the new additional zone fields).

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Schedule and view the load for a warehouse or site

Create a space utilization setup for a warehouseCreate a space utilization setup for a warehouse

Associate a space utilization setup with a master planAssociate a space utilization setup with a master plan

Specify the load utilization projection and view informationSpecify the load utilization projection and view information

You can schedule load utilization for selected location types, and you can also project the current and future load

utilization. You can project the load for one or more sites, for the load units (zone or warehouse), or for a

combination of a zone and a warehouse.

To schedule the load for sites, warehouses, or zones, you create a space utilization setup and associate it with a

master plan.

In the space utilization setup, you use location types, such as Bulk locationBulk location and Picking locationPicking location, to specify

how space utilization should be projected. You also specify a storage load mode, such as ZoneZone.

The projection of future space utilization is based on information that is calculated on the associated master

plan. Master plans forecast the resource planning for incoming and outgoing orders for production and

operations. The projection of available space is based on the relation between the space utilization setup and the

selected master plan.

By using the storage load mode that you selected in the space utilization setup, you can specify whether the load

should be projected for each warehouse or zone, or whether the projections should include information about

both warehouses and zones. You also specify whether blocked locations should be excluded from the calculation

of load utilization.

You can project the space utilization by generating the Warehouse load utilizationWarehouse load utilization report. When you

generate this report, you can specify whether the load utilization should be projected for each site, across sites,

or for the selected load unit, such as zone or warehouse.

1. Select Inventor y managementInventor y management > SetupSetup > Warehouse monitor ingWarehouse monitor ing > Space utilizationSpace utilization.

2. Select NewNew  to create a space utilization setup. Specify an ID and a name for the new setup.

3. In the Storage load modeStorage load mode field, select whether the overview of space utilization should show information

by warehouse, zone, or warehouse and zone.

4. Set the Exclude blocked locationsExclude blocked locations  option to YesYes  to exclude blocked inventory locations from the

calculation of available space. You can block an inventory location for input and output by specifying a

blocking cause for the location in the Input blockedInput blocked or Output blockedOutput blocked field on the OtherOther  FastTab on the

Inventor y locationsInventor y locations  page.

5. On the Location typeLocation type FastTab, select the location types to include in the space utilization calculation. You

must select at least one location type for the projection.

1. Select Inventor y managementInventor y management > Periodic tasksPeriodic tasks  > Schedule load utilizationSchedule load utilization.

2. In the Master planMaster plan field, select a master plan.

3. In the Number of daysNumber of days  field, specify the number of days to include in the projection of current and future

workloads.

4. In the Space utilizationSpace utilization field, select the space utilization setup to use for the projection of current and

future workloads.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/schedule-load-utilization.md


NOTENOTE

1. Select Inventor y managementInventor y management > Inquir ies and repor tsInquir ies and repor ts  > Physical inventor y repor tsPhysical inventor y repor ts  >

Warehouse load utilizationWarehouse load utilization.

2. In the Show byShow by  field, select the level of the space utilization projection:

S iteSite – Project the space utilization for each site. This projection is useful if, for example, you want to

view all the warehouses for a site so that you can balance the space utilization between the

warehouses.

Load unitLoad unit – Project the space utilization for zones or warehouses. The available space is then

projected according to the value that you selected in the Storage load modeStorage load mode field on the SpaceSpace

utilizationutilization page when you created the space utilization setup.

3. Follow one of these steps, depending on the value that you selected in the previous step:

If you selected S iteSite in the Show byShow by  field, the S iteSite field is available. Select one or more sites to include

in the projection.

If you selected Load unitLoad unit in the Show byShow by  field, the Load unitLoad unit field is available. Select the load unit.

4. In the Load typeLoad type field, select VolumeVolume or WeightWeight to specify the warehouse operating unit to project

space for.

5. In the Space utilization setupSpace utilization setup field, select the space utilization setup that the projection should be

based on.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Schedule and view workloads for a warehouse

Create a workload capacity setup for a warehouseCreate a workload capacity setup for a warehouse

Define limits for volume or weightDefine limits for volume or weight

You can schedule workload capacity for warehouses, and you can also project the current and future workloads

for the workers in individual warehouses. You can project the workload for the whole warehouse, or you can

project the workload separately for incoming and outgoing workloads.

To project workload output for selected warehouses, master scheduling data must be available for those

warehouses. For more information, see Master plans overview.

To schedule workload capacity for a warehouse, you create a workload setup for one or more warehouses, and

then associate the workload setup with a master plan. In the workload capacity setup, you can define limits for

the weight or volume for incoming and outgoing transactions. You can also create more than one setup for each

warehouse and then associate the setup with individual master plans. For example, you might use this approach

to accommodate seasonal changes in the workforce.

If the workers for a warehouse work with transactions for both incoming and outgoing workloads, you can

configure the warehouse capacity setup so that the workload is projected in a combined view.

To schedule and view workloads for warehouses, you must complete the following tasks:

1. Create a workload capacity setup and define workload capacity limits for one or more warehouses.

2. Associate the workload capacity setup with a master plan to create workload projections and specify how

long those projections will apply.

NOTENOTE

1. Select Inventor y managementInventor y management > SetupSetup > Warehouse monitor ingWarehouse monitor ing > Workload capacityWorkload capacity .

2. On the Action Pane, select NewNew  to create a workload capacity setup.

3. On the WarehousesWarehouses  FastTab, select NewNew , and then enter values on the line to associate a warehouse

with the workload capacity setup.

4. Select the Combined inbound and outbound workloadCombined inbound and outbound workload check box if the Workload capacityWorkload capacity  report

should show the total workload for incoming and outgoing transactions in one view.

5. On the Transaction typesTransaction types  FastTab, select the types of incoming and outgoing transactions that the

workload limits will apply to.

You must select at least one transaction type for both the incoming workload and the outgoing workload.

You can set up limits for volume or weight, depending on the limitation that is relevant for the warehouse

workforce. The limits that you specify are included in the workload capacity projection that you can view on the

Workload capacityWorkload capacity  report.

To project information about volume and weight for items, the standard volume of one inventory item and the

weight of one inventory item must be specified for all products. The fields that are required are available in the

following field groups on the Manage inventor yManage inventor y  FastTab of the Released product detailsReleased product details  page:

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/schedule-workload-capacity.md


Associate a workload capacity setup with a master planAssociate a workload capacity setup with a master plan

View workload capacityView workload capacity

NOTENOTE

Handling

Physical dimensions

Weight measurements

If this information isn't specified correctly, you receive a message when you generate the Workload capacityWorkload capacity

report. From the report, you can then drill down to identify the missing information that is required in order to

project the future workload.

1. Select Inventor y managementInventor y management > PeriodicPeriodic > Schedule workloadSchedule workload.

2. In the Master planMaster plan field, select the master plan to use for workload projections.

3. In the Number of daysNumber of days  field, specify the number of days that the workload projection covers.

4. In the WorkloadWorkload field, select the workload setup to associate with the master plan.

1. Select Inventor y managementInventor y management > Inquir ies and repor tsInquir ies and repor ts  > Physical inventor y repor tsPhysical inventor y repor ts  > WorkloadWorkload

capacitycapacity .

2. In the Number of columnsNumber of columns  field, specify the number of columns to show on the report.

3. In the Order typeOrder type field, select Planned and confirmedPlanned and confirmed, PlannedPlanned, or ConfirmedConfirmed to indicate the type of

orders to project on the report.

4. In the Load typeLoad type field, select a load type to specify whether the workload capacity should be projected for

volume or weight.

5. In the Workload capacityWorkload capacity  field, select a workload capacity setup.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Set up dispositions codes
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NOTENOTE

This procedure focuses on the setup of a disposition code that can be used on a mobile device for the return

order receiving process. Disposition codes are a collection of rules that can be used when items are received. For

example, when a work user uses a mobile device to receive items that were damaged, the user must scan a

disposition code for damaged items. The inventory status of the goods received, the work template, and the

location directive can be determined from the scanned disposition code. For the purchase order receiving

process and the production order report as finished process, the use of a disposition code is optional. For the

sales order return receiving process, if the items are registered using a mobile device, the use of disposition

code is mandatory. This guide was created using the demo data company USMF. This procedure is intended for

the warehouse manager.

1. Go to Warehouse management > Setup > Mobile device > Disposition codes.

2. Click New.

3. In the Disposition code field, type a value.

4. In the Inventory status field, select an inventory status where there is inventory blocking.

5. In the Work template field, type a value.

6. In the Return disposition code field, type a value.

Create a new disposition code to use for customer returns.

If you're using USMF, select 'Blocking'. You can add an inventory status to the disposition code to

override the default status that's on the order lines.

Optional: Select a work template code that is associated with a return order. If no value is provided, the

work template will be resolved using the standard rules configured in your system. Selecting a work

template will limit the processes this disposition code can be used with. For example, if a disposition

code has a work template with a work order of type purchase order, it can't be used to register items

that are returned by customers.

The return disposition code determines the remainder of the return order process for the items

registered. In this example, the customer should receive a credit note. Add a returns disposition code

that contains an action Credit.
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Unit sequence groups for released products

License plate grouping

Units for cycle counting

Default units for mobile device receiving processes

This article describes how default units, unit sequences, and unit conversions are used in warehouse processes.

Unit sequence groups define the sequence of units that can be used in warehouse operations. They are created

on the Unit sequence groupsUnit sequence groups  page. The sequence shows the relationship of the various units. For example,

you store pallets that contain boxes that contain individual pieces of items. In this case, you must provide the

three different units and the logical order of the layers. Unit sequence groups let you define the policies for the

grouping of license plates, and the default units that should be used for various warehouse processes. This

article applies to both the advanced warehousing solution that is available in Warehouse management and the

more basic warehousing solution that is available in Inventory management.

If you want to use released products in warehouse work processes, a unit sequence group must be assigned to

them. If you validate a product that is associated with a Storage dimension group, and the Use warehouseUse warehouse

management processesmanagement processes  option for the Storage dimension group is set to YesYes , you receive an error message if

a unit sequence group ID isn't defined for the product. If the unit sequence group that you use contains multiple

lines (and therefore multiple units), you must set up a unit conversion between the units. You complete this

setup on the Unit conversionsUnit conversions  page. The smallest unit in a sequence group that you associate with a released

product must match the inventory unit that is defined for the corresponding product. The inventory unit is the

unit that is used for base calculations of the on-hand inventory. You can also set up unit of measure conversions

for product variants of product masters by using the Enable unit of measure conversionsEnable unit of measure conversions  option.

You can specify whether receipts of less than or more than a specific unit should be grouped into one license

plate or divided into a license plate for each unit. To set up this behavior, use the L icense plate groupingLicense plate grouping

option on the L ine detailsL ine details  tab of the Unit sequence groupsUnit sequence groups  page. If you want to use the license plate

grouping when you process work by using a mobile device, the L icense plate groupingLicense plate grouping option must be

selected on the Mobile deviceMobile device menu item. For example, you're using a mobile device to register an item that is

associated with a unit sequence group that has two lines. The first line is for Pieces, and the L icense plateLicense plate

groupinggrouping option is set to YesYes . The second line is for the Pallet unit, and the L icense plate groupingLicense plate grouping option is

set to NoNo. In this case, the system can automatically guide the split and creation of license plates per 100 pieces.

To define which units should be used as part of the cycle counting processes, select the Use unit for cycleUse unit for cycle

countingcounting option on the Unit sequence groupsUnit sequence groups  page. You can select a maximum of four units in the sequence

group. If you select more than four units, the additional units won't be shown on the mobile device.

To set the default units that should be used for receiving processes on mobile devices, enable the Default unitDefault unit

for purchase and transferfor purchase and transfer  and Default unit for productionDefault unit for production options on the Unit sequence groupsUnit sequence groups  page.

For example, you can specify that, by default, the system should use Pallet quantities when purchase order on-

hand inventory is received by using a mobile device, but that the stock-keeping unit should be Pieces. To get the

conversion for the number of pieces that each pallet contains, you must define a unit conversion, such as 100

Pcs = 1 PL.
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Default order settings

NOTENOTE

As part of the creation of released products, you must select default units for purchases, sales, and inventory to

process the various orders. You can set the default units and quantities for the various source documents by

using the Default order settingsDefault order settings  and S ite specific order settingsSite specific order settings  pages. You can access these pages from

the Released productsReleased products  page.
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Overview

Accessing the Power BI content pack

Metrics that are included in the Power BI content

This topic describes what's included in the Warehouse performanceWarehouse performance Microsoft Power BI content. It explains

how to access the Power BI reports, and provides information about the data model and entities that are used to

build the content.

The Warehouse performanceWarehouse performance Power BI content was created so that warehouse and operations managers can

monitor important inbound, outbound, and inventory metrics. It uses Warehouse management, product, and

other transactional data from your system, and provides both an aggregate view of warehouse performance

and a breakdown for vendors, product groups and products, and site and warehouses.

Warehouse managers can use the Warehouse performanceWarehouse performance Power BI content to measure the following three

areas:

Inbound performanceInbound performance – Measure how well a vendor is performing against customer requirements (in

other words, measure delivery performance), and measure put-away performance, so that you can identify

issues that involve workers or items over a period. It's important that you know whether vendors are

delivering on time, early, or late, so that you can determine how vendor performance is affecting overall put-

away performance. A vendor that delivers outside the dates that were agreed on can put extra pressure on

the warehouse because of unexpected work, and can increase the average put-away time.

Shipping performanceShipping performance – Measure whether your warehouse is shipping in full and on time to customers (in

other words, measure outbound shipping and delivery performance), so that you can identify any issues that

involve products, sites or warehouses, or dedicated customers. If you find that you're shipping late to specific

areas or towns, you might have to pay more attention to transportation or account management.

Location inventor y accuracyLocation inventor y accuracy  – Inventory accuracy is important internal warehouse business intelligence

(BI). It's very important that you determine how accurately you're counting in general. However, it's also

important that you determine how accurate you are at storing items in the correct locations, and that you

highlight discrepancy data, so that you can find better positions for items or initiate total counting on specific

items. (Currently, the new item-based counting functionality is delivered as a hotfix.) If you're using this

Power BI content to determine the correctness of on-hand inventory data per location, you can also identify

theft in your shops. You can also determine whether any locations have on-hand quantities that differ from

enterprise resource planning (ERP) data. Those locations might be too large, or they might be impossible to

count. Alternatively, some of the physical positioning might be bad, so that it's difficult to keep a single type

of item in sync with on-hand data.

The Warehouse performanceWarehouse performance Power BI content is shown on the Warehouse performanceWarehouse performance page

(Warehouse managementWarehouse management > Inquir ies and repor tsInquir ies and repor ts  > Warehouse performance analysisWarehouse performance analysis  > WarehouseWarehouse

performanceperformance).

The Warehouse performanceWarehouse performance Power BI content includes a report. This report consists of a set of metrics that

are visualized as charts, tiles, and tables. The following table provides an overview of the visualizations in the

Warehouse performanceWarehouse performance Power BI content.
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Inbound Performance Total put aways The number of put-away work lines
that are processed during a given time.

Inbound Performance Put away average time The average time, in hours, for all
purchase order put-away lines that are
processed, from registration of the
items until the last put is processed.

Inbound Performance Received early The number of purchase order lines
that are received early.

Inbound Performance Received on time The number of purchase order lines
that are received on time.

Inbound Performance Received late The number of purchase order lines
that are received late.

Inbound Performance On time by vendor A view of the percentage of purchase
order lines that are received from a
vendor or vendor group early, on time,
and late.

Inbound Performance Dock to stock average put away
(hours)

The average dock-to-stock put-away
time in hours over time.

Inbound Performance Average put away by worker The average time, in hours, that a
worker has been taking for put-away
processing of purchase order lines.

Inbound Performance Average put away hour by vendor The average put-away time in hours by
vendor or vendor group.

Inbound Performance Average put away hour by product The average put-away time in hours by
item or item group.

Location inventory accuracy Total count The number of counting work lines
that are processed for a given period.

Location inventory accuracy Discrepancy rate The total discrepancy rate as a
percentage of all lines that are counted
for a given period.

Location inventory accuracy Count without discrepancy Of the total number of counting work
lines that are processed, the number of
lines that are processed without any
discrepancy.

Location inventory accuracy Items counted over time The percentage of items that are
counted with and without discrepancy
over time.



Location inventory accuracy Item quantity discrepancy greater than
%

A table view of counting lines that
have discrepancies that exceed a
specified percentage. The table
includes information about locations,
items, the average discrepancy, the
total counting work lines that are
counted, the number of counting lines
that have discrepancies for the
location, the average quantity that is
counted, the expected total quantity
that will be counted, and the actual
item quantity that is counted.

Location inventory accuracy Item count by worker The counting performance of workers.
Performance is expressed as a
percentage of counting work lines that
have and don't have discrepancies.

Location inventory accuracy Item count by site / warehouse Counting performance by the number
of processed counting work lines by
site or warehouse that have and don't
have discrepancies.

Location inventory accuracy Discrepancy rate by product The discrepancy rate for counting
performance. The rate is expressed as a
percentage of processed counting
work lines by item or item group.

Shipping performance Lines shipped The total number of shipment lines
that are shipped over a given period.

Shipping performance Early The percentage of shipment lines that
are shipped early.

Shipping performance On time The percentage of shipment lines that
are shipped on time.

Shipping performance Late The percentage of shipment lines that
are shipped late.

Shipping performance Shipments over time The percentage of shipment lines that
are shipped on time, early, or late over
a given period. A trend line shows the
trend for lines that are shipped on
time.

Shipping performance Shipped late by city A map visualization of cities and areas
that are affected by late shipments.

Shipping performance Shipped by product The percentage that is shipped early,
on time, or late by item or item group.

Shipping performance Shipped by customer The percentage that is shipped early,
on time, or late by customer or
customer group.
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Shipping performance Shipped by site / warehouse The percentage that is shipped early,
on time, or late by site or warehouse.

REP O RT  PA GEREP O RT  PA GE C H A RT SC H A RT S DESC RIP T IO NDESC RIP T IO N

Understanding the data model and calculations
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Inbound Performance Total put aways WHSWorkLine The count of work lines
where the work type is putput .

Inbound Performance Put away average time WHSWorkLine The sum of work lines max.
time divided by the count
of work lines max. time,
where work lines max. time
is the maximum gap
between the work created
date and the closed date.

Inbound Performance Received early WHSWorkLine The count of work lines
where the work created
date is earlier than the
delivery date that is used. If
the delivery confirmed date
isn't set, use the default
delivery date.

Inbound Performance Received on time WHSWorkLine The count of work lines
where the work created
date is equal to the delivery
date that is used. If the
delivery confirmed date isn't
set, use the default delivery
date.

Inbound Performance Received late WHSWorkLine The count of work lines
where the work created
date is later than the
delivery date that is used. If
the delivery confirmed date
isn't set, use the default
delivery date.

Inbound Performance On time by vendor WHSWorkLine Received early, Received on
time, and Received late (see
the descriptions earlier in
this table).

The following data is used to fill the report pages in the Warehouse performanceWarehouse performance Power BI content. This data

is represented as aggregate measurements that are staged in the Entity store. The Entity store is a Microsoft SQL

Server database that is optimized for analytics. For more information, see Power BI integration with Entity store.

The following key aggregate measurements are used as the basis of the content.



Inbound Performance Dock to stock average put
away (hours)

WHSWorkLine Put away average time (see
the description earlier in
this table).

Inbound Performance Average put away by
worker

WHSWorkLine Put away average time (see
the description earlier in
this table).

Inbound Performance Average put away hour by
vendor

WHSWorkLine Put away average time (see
the description earlier in
this table).

Inbound Performance Average put away hour by
product

WHSWorkLine Put away average time (see
the description earlier in
this table).

Location inventory accuracy Total count WHSWorkLineCycleCount Cycle counts where the
absolute discrepancy
quantity is equal to or more
than 0 (zero).

Location inventory accuracy Discrepancy rate WHSWorkLineCycleCount Cycle counts that have
discrepancies, divided by
the total count. A cycle
count is considered to have
discrepancies if the absolute
discrepancy quantity is
more than 0 (zero).

Location inventory accuracy Count without discrepancy WHSWorkLineCycleCount Cycle counts where the
absolute discrepancy
quantity is more than 0
(zero).

Location inventory accuracy Count with discrepancy WHSWorkLineCycleCount Cycle counts where the
absolute discrepancy
quantity is equal to 0 (zero).

Location inventory accuracy Items counted over time WHSWorkLineCycleCount Count without discrepancy
and Count with discrepancy
(See the descriptions earlier
in this table.)
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Location inventory accuracy Item quantity discrepancy
greater than %

WHSWorkLineCycleCount The average discrepancy is
the absolute discrepancy
quantity divided by the
expected quantity where
the absolute discrepancy
quantity is more than 0
(zero). The average
discrepancy quantity is the
average absolute
discrepancy quantity where
the absolute discrepancy
quantity is more than 0
(zero). Count with
discrepancy, Total count,
Expected quantity, and
Counted quantity where
the whole quantity is
grouped by item and
location (see the
descriptions earlier in this
table).

Location inventory accuracy Item count by worker WHSWorkLineCycleCount Count without discrepancy
and Count with discrepancy
(see the descriptions earlier
in this table).

Location inventory accuracy Item count by site /
warehouse

WHSWorkLineCycleCount Count without discrepancy
and Count with discrepancy
(see the descriptions earlier
in this table).

Location inventory accuracy Discrepancy rate by product WHSWorkLineCycleCount Discrepancy rate (see the
description earlier in this
table).

Shipping performance Lines shipped SalesLine The count of sales lines
where sales lines are
shipped.

Shipping performance Early CustPackingSlipOnTimeStat
us

Sales lines where the ship
date status is 1 (Early)1 (Early) .
Early means that the ship
date of the packing slip is
earlier than the confirmed
ship date of the sales line. If
the confirmed ship date
isn't set, use the requested
ship date.
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Shipping performance On time CustPackingSlipOnTimeStat
us

Sales lines where the ship
date status is 2 (On time)2 (On time).
On time means that the
ship date of the packing slip
is equal to the confirmed
ship date of the sales line. If
the confirmed ship date
isn't set, use the requested
ship date.

Shipping performance Late CustPackingSlipOnTimeStat
us

Sales lines where the ship
date status is 3 (Late)3 (Late). Late
means that the ship date of
the packing slip is later than
the confirmed ship date of
the sales line. If the
confirmed ship date isn't
set, use the requested ship
date.

Shipping performance Shipments over time SalesLine
CustPackingSlipOnTimeStat
us

Orders that are fully
shipped, where the whole
quantity of the sales line is
shipped, plus Early, On time,
and Late (see the
descriptions earlier in this
table).

Shipping performance Shipped late by city CustPackingSlipOnTimeStat
us

Late (see the descriptions
earlier in this table).

Shipping performance Shipped by product CustPackingSlipOnTimeStat
us

Early, On time, and Late
(see the descriptions earlier
in this table).

Shipping performance Shipped by customer CustPackingSlipOnTimeStat
us

Early, On time, and Late
(see the descriptions earlier
in this table).

Shipping performance Shipped by site / warehouse CustPackingSlipOnTimeStat
us

Early, On time, and Late
(see the descriptions earlier
in this table).
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NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


System grouping on an open work list
2/18/2021 • 2 minutes to read • Edit Online

Set up system grouping on an open work list

O P T IO NO P T IO N DESC RIP T IO NDESC RIP T IO N

Allow system grouping Enables system groping for a selected work list menu item.

System grouping field Available only if Allow system workAllow system work is set to YesYes . Select
the field that determines how picking work will be grouped
for workers. For example, if you select the ShipmentIdShipmentId field,
the worker will scan the shipment ID to group the picking
work. All work for the shipment is then assigned to the
worker. This field requires that you create a menu item to
use existing work that is grouped by the system. Use the
System grouping labelSystem grouping label field to inform the worker what to
scan.

System grouping label Available only if Allow system workAllow system work is set to YesYes . Enter
information for the worker about what to scan when picking
work is grouped. For example, if you use the ShipmentIdShipmentId
field to group picking work by shipment, you might enter
Shipment ID in the field. This field requires that you create a
menu item to use existing work that is grouped by the
system. You must also select the field to group by in the
System groupingSystem grouping field.

NOTENOTE

By using a system grouping field, you can filter an open work list without having to edit the mobile device menu

item. Where it applies, system grouping works for filtering a work list on a single work header field. You cannot

use system grouping to filter on line level fields.

Use these steps to set up system grouping on an open work list.

From a mobile device menu item, select Mode: IndirectMode: Indirect and Activity Code: Display open work listActivity Code: Display open work list. The

following options become available. These options are required for system grouping on an open work list.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/system-group-on-open-work-list.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Document routing layout for license plate labels
2/18/2021 • 3 minutes to read • Edit Online

^XA~TA000~JSN^LT0^MNW^MTD^PON^PMN^LH0,0^JMA^PR2,2~SD15^JUS^LRN^CI0^XZ
^XA
^MMT
^PW320
^LL0160
^LS0
^FT20,58^A0N,28,28^FH\^FDLabel:^FS
^FT20,81^AAN,18,10^FH\^FD$LicensePlateId$^FS
^BY1,3,17^FT20,106^BCN,,Y,N,N,A
^FD$LicensePlateId$^FS
^PQ1,,,Y^XZ

Custom number formats

$FieldName:FormatString$

The document routing layout defines the layout of license plate labels, and the data that is printed on them. You

configure the printing trigger points when you set up mobile device menu items and work templates.

In a typical scenario, warehouse receiving clerks print license plate labels immediately after they record the

contents of pallets that arrive in the receiving area. The physical labels are applied to the pallets. They can then

be used for validation as part of the put-away process that follows and future outbound picking operations.

You can print highly complex labels, provided that the printing device can interpret the text that is sent to it. For

example, a Zebra Programming Language (ZPL) layout that includes a bar code might resemble the following

example.

As part of the label printing process, the text $LicensePlateId$  in this example will be replaced with a data

value.

To see the values that will be printed, go to Warehouse management > Inquir ies and repor ts > L icenseWarehouse management > Inquir ies and repor ts > L icense

plate labelsplate labels .

Several widely available label generation tools can help you format the text for the label layout. Many of these

tools support the $FieldName$  format. In addition, Microsoft Dynamics 365 Supply Chain Management uses

special formatting logic as part of the field mapping for the document routing layout.

You can customize the formatting of numerical field values that are printed by using codes that have the

following format.

Here is an explanation of this format:

FieldName  is the name of the data field (such as QtyQty ).

FormatString  defines how the data must be printed.

The following examples show how you can customize the work quantity (QtyQty ) field:

To always show four digits (by using zeros as placeholders), use $Qty:0000$ . For example, if the quantity is

10, the label will show "0010."

To always show two decimal places, use $Qty:0.00$ . For example, if the quantity is 10, the label will show

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/document-routing-layout-for-license-plates.md


Custom string formats

$FieldName:#..$

Custom date/time formats

$PrintedDate:dd-MM-yyyy$

Print individual lines from multiline data

$FieldName[#]$

C O DEC O DE T EXT  T H AT  IS P RIN T EDT EXT  T H AT  IS P RIN T ED

$AdditionalAddress[1]$ Contoso Inc.

$AdditionalAddress[2]$ 123 Street Name

$AdditionalAddress[3]$ Some City, Some State

Print and format from a display method

"10.00."

For a complete list of the available number format strings, see Custom numeric format strings.

You can remove the first characters of a string by using the following field and format code.

Here, #  specifies the number of characters to skip. For example, to print a Serial Shipping Container Code

(SSCC) license plate number that doesn't include the first two characters, use $LicensePlateId:2..$ . In this case,

the license plate number 0011111111111222221 will be printed as "11111111111222221."

The following example shows how you can control the format that is used to print dates.

In this example, the date April 30, 2020, will be printed as "30-04-2020."

For a complete list of the available date/time formats, see Custom date and time format strings.

If a data field contains multiple lines (that is, lines that are separated by line breaks), you can print an individual

line by using the following format.

Here, #  is the line number that you want to print. (Use 1 for the first line.)

For example, your system has an AdditionalAddress  field that stores the following multiline address:

Contoso Inc.

123 Street Name

Some City, Some State

You can print this address, one line at a time, by using the following codes.

You can print from a display method by using the following format.

https://docs.microsoft.com/en-us/dotnet/standard/base-types/custom-numeric-format-strings
https://docs.microsoft.com/en-us/dotnet/standard/base-types/custom-date-and-time-format-strings


$DisplayMethod()$

$DisplayListOfItemsNumbers()[1]$

More information about how to print labels

NOTENOTE

You can combine this format with other types that were described earlier in this topic. For example, you have a

display method that is named DisplayListOfItemsNumbers() , and you want to print the first item number of this

method. In this case, you can use the following code.

For more information about how to set up and print labels, see Enable license plate label printing.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Mobile barcode support
2/18/2021 • 2 minutes to read • Edit Online

NOTENOTE

Because Android is an open source project, any manufacturer of hardware for warehouse bar code scanners can

build a device to run the Android operating system. A device is only Android-compatible if it can run apps that

are written for the Android execution environment. However, a hardware vendor can modify and create overlays

for the Android version that runs on their hardware. Microsoft cannot take any responsibility to ensure that a

mobile bar code scanning app for Android is compatible with a manufacturer ’s bar code scanning hardware and

the Android version that runs on it.

The Dynamics 365 Supply Chain Management - warehouse app has been tested with a selection of Android

powered devices for bar code scanning. These tests only cover a sample of the devices that are available on the

market.

As a customer, we recommend that you test the Warehouse mobile scanning app on selected hardware before

you decide on the hardware that you want to buy.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/mobile-barcode-support.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Set up warehouses for transfer orders
2/18/2021 • 2 minutes to read • Edit Online

TIPTIP

Set up transport lead time

NOTENOTE

You can use warehouse levels to create a hierarchy that supports transfer orders between warehouses. Based on

this setup, master scheduling calculates item requirements at the individual warehouse level and generates

planned transfer orders from an assigned source warehouse to fulfill them.

NOTENOTE

1. Click Inventor y management > Setup > Inventor y breakdown > WarehousesInventor y management > Setup > Inventor y breakdown > Warehouses .

2. Select the warehouse that you want to refill.

3. On the Master planningMaster planning FastTab, select the Refill ingRefill ing check box.

4. In the Main warehouseMain warehouse field, select the warehouse that you want to assign as the refilling warehouse.

Master scheduling calculates a transfer requirement for the selected warehouse and generates a planned

transfer order from the assigned Main warehouseMain warehouse.

If you clear the RefillingRefilling check box, the selected warehouse is assigned a warehouse level in regard to the MainMain

warehousewarehouse, but the Main warehouseMain warehouse is not set up as a refilling warehouse.

5. Close the page to apply the new setup.

If you want to assign a warehouse for refilling, you must first set up the warehouse as a storage dimension on the

Storage dimension groupsStorage dimension groups page. On this page, select the ActiveActive field and the Coverage plan by dimensionCoverage plan by dimension field

for the warehouse.

You must also set up the transport lead time between the warehouses on the Transpor t daysTranspor t days  page.

1. Go to Inventor y management > Setup > Distr ibution > Transpor t daysInventor y management > Setup > Distr ibution > Transpor t days .

2. In the Receiving pointReceiving point field, select warehousewarehouse.

3. Select the Shipping warehouseShipping warehouse, Receiving warehouseReceiving warehouse, and Transpor t daysTranspor t days .

4. (Optional) You can also set transport time, depending on the mode of delivery, under the Transpor t daysTranspor t days

per mode of deliver yper mode of deliver y  tab.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/transfer-orders-warehouse.md
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Troubleshoot warehouse configuration
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I receive the following error message: "The license plate or location is
not valid."
Issue descriptionIssue description

Issue resolutionIssue resolution

I receive the following error message: "License plate must be
specified for this location."
Issue descriptionIssue description

Issue resolutionIssue resolution

I receive the following error message: "You can't create a work
template line for Inventory status change because the work type is
not valid. Select a different work type."
Issue descriptionIssue description

Issue resolutionIssue resolution

I receive the following error message: "The Quantity is not valid for
unit 1%."
Issue descriptionIssue description

This topic describes how to fix common issues that you might encounter while you configure Microsoft

Dynamics 365 Supply Chain Management.

You receive this error message when you scan a license plate ID or location.

Make sure that the license plate ID isn't reserved by something else. This issue used to occur when the value that

a user scanned in the warehouse app was both a valid location and a valid license plate ID. However, this issue

was resolved in version 10.0.11.

You receive this error message if you create a transfer order by using a warehouse that is enabled for advanced

warehouse management (WMS), and then, after the work is completed, you try to confirm the shipment.

The Default receipt locationDefault receipt location field is blank for a transit warehouse of the "from" warehouse. To fix this issue,

specify a default receipt location in the transit warehouse. Make sure that this location is license plate–

controlled.

For a work template, you can't select Inventory status change in the Work typeWork type column of the Work templateWork template

detailsdetails  section.

This behavior is by design. The Inventory status change work type is used only by system processes. It can't be

configured. Because the list of work types is fixed as an enumeration, the extra entries can't be filtered out of the

Work typeWork type drop-down menu.

The quantity isn't valid for the ea unit when there is picking work that has multiple license plates in one location.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/troubleshoot-warehouse-configuration.md


Issue resolutionIssue resolution

In location directives for sales order put work, the multiple SKU
option doesn't evaluate multiple location directive actions.
Issue descriptionIssue description

Issue resolutionIssue resolution

I can't use the warehouse app to do partial picking.
Issue descriptionIssue description

Issue resolutionIssue resolution

How can I do an inventory status change for partial quantity work?
Issue descriptionIssue description

Issue resolutionIssue resolution

NOTENOTE

Verify that the Unit sequence group IDUnit sequence group ID and Unit conversionsUnit conversions  fields on the released product or product

variant are set correctly.

Note that the error message has been improved in version 10.0.15 (see KB 4581627). The new error message is,

"The quantity is not valid. Expected %1 %2."

Location directives of the Sales orders work order type and the Put work type don't evaluate multiple location

directive actions when the Multiple SKUMultiple SKU option is selected. Only the first location directive action is evaluated.

A new feature, Evaluate all actions for Multi SKU location directives, has been added in version 10.0.15 (see KB

4579866). This feature evaluates all actions for multi-SKU location directives. If you require this feature, use

Feature management to turn it on.

For sales and transfer orders, you can't skip items and do partial picking.

On the Mobile device menu itemsMobile device menu items page, for each menu item that is set up to process sales orders or transfer

orders, set the Allow splitting of workAllow splitting of work option on the GeneralGeneral  FastTab to Yes.

You want to do an inventory status change for a partial quantity of a batch.

To enable workers to make this change, you can create a menu item for the warehouse app. On the MobileMobile

device menu itemsdevice menu items page, create (or edit) a menu item that has the following settings:

Mode:Mode: Work

Use existing work :Use existing work : No

Work creation process:Work creation process: Movement

Display inventor y status:Display inventor y status: Yes

You can set other fields on the page as you require.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://fix.lcs.dynamics.com/Issue/Details/?bugId=486531
https://fix.lcs.dynamics.com/Issue/Details?kb=4579866&bugId=475946&dbType=3&qc=1bc41a56de7a3ee419fa76397a6bf282fce5be9b93e427c08a6d916d1dfa3091
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Install and connect the Warehouse Management
mobile app
2/18/2021 • 15 minutes to read • Edit Online

IMPORTANTIMPORTANT

NOTENOTE

System requirements

Turn on the feature

Get the Warehouse Management mobile app

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

This topic describes how to configure the new Warehouse Management mobile app, which is currently in public preview. If

you're looking for information about how to configure the old warehouse app, see Install and connect the warehouse app.

The public preview of the Warehouse Management mobile app is available for download on Microsoft App

Center. It's provided as a standalone component. Therefore, you must download it on each device and then

configure it to connect to your Microsoft Dynamics 365 Supply Chain Management environment.

This topic explains how to install the Warehouse Management mobile app on each of your mobile devices and

configure it to connect to your Supply Chain Management environment. You can configure each device

manually, or you can import connection settings through a file or by scanning a QR code.

The Warehouse Management mobile app is available for both Windows and Google Android operating systems.

To use the app, one of the following operating systems must be installed on your mobile devices:

Windows 10 (Universal Windows Platform [UWP]) October 2018 update 1809 (build 10.0.17763) or later

Android 4.4 or later

Before you can use the app, a related feature must be turned on in your system. Admins can use the Feature

management workspace to check the status of the feature and turn it on if it's required. There, the feature is

listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: User settings, icons, and step titles for the new warehouse app

Use one of the following links to download the app:

Windows (UWP):Windows (UWP): App Center preview program - Windows

Because this app is a preview app, a few extra steps are required to install it. For details, see Install a Build

from App Center.

Android:Android: App Center preview program - Android

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/install-configure-warehouse-management-app.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version
https://go.microsoft.com/fwlink/?linkid=2154406
https://docs.microsoft.com/en-us/appcenter/distribution/installation
https://go.microsoft.com/fwlink/?linkid=2154613


     Create a web service application in Azure Active Directory

Because this app is a preview app, a few extra steps are required to install it. For details, see Testing

Android Apps.

For smaller deployments, you might want to install the app on each device from the relevant store and then

manually configure the connection to the environments that you're using. However, you can also automate app

deployment and/or configuration. You might find this approach convenient if you manage many devices, and

you're using a mobile device management and mobile application management solution such as Intune. For

information about how to use Intune to add applications, see Add apps to Microsoft Intune.

To enable the Warehouse Management mobile app to interact with a specific Supply Chain Management server,

you must register a web service application for the Supply Chain Management tenant in Azure Active Directory

(Azure AD). The following procedure shows one way to complete this task. For detailed information and

alternatives, see the links after the procedure.

1. In a web browser, go to https://portal.azure.com.

2. Enter the name and password of the user who has access to the Azure subscription.

3. In the Azure portal, in the left navigation pane, select Azure Active Director yAzure Active Director y .

4. Make sure that you're working with the instance of Azure AD that is used by Supply Chain Management.

5. In the ManageManage list, select App registrationsApp registrations .

https://docs.microsoft.com/en-us/appcenter/distribution/testers/testing-android
https://docs.microsoft.com/en-us/mem/intune/fundamentals/what-is-intune
https://docs.microsoft.com/en-us/mem/intune/apps/apps-add
https://portal.azure.com/


6. On the toolbar, select New registrationNew registration to open the Register an applicationRegister an application wizard.

7. Enter a name for the application, select the Accounts in this organizational director y onlyAccounts in this organizational director y only  option,

and then select RegisterRegister .

8. Your new app registration is opened. Make a note of the Application (client) IDApplication (client) ID value, because you will

need it later. This ID will be referred to later in this topic as the client ID.



9. In the ManageManage list, select Cer tificate & secretsCer tificate & secrets . Then select one of the following buttons, depending on

how you want to configure the app for authentication. (For more information, see the Authenticate by

using a certificate or client secret section later in this topic.)

Upload cer tificateUpload cer tificate – Upload a certificate to use as a secret. We recommend this approach, because

it's more secure and can also be automated more completely. If you're running the Warehouse

Management mobile app on Windows devices, make a note of the ThumbprintThumbprint value that is shown

after you upload the certificate. You will need this value when you configure the certificate on

Windows devices.

New client secretNew client secret – Create a key by entering a key description and a duration in the PasswordsPasswords

section, and then select AddAdd. Make a copy of the key, and store it securely.

For more information about how to set up web service applications in Azure AD, see the following resources:

For instructions that show how to use Windows PowerShell to set up web service applications in Azure

AD, see How to: Use Azure PowerShell to create a service principal with a certificate.

For complete details about how to manually create a web service application in Azure AD, see the

following topics:

https://docs.microsoft.com/en-us/azure/active-directory/develop/howto-authenticate-service-principal-powershell


 

Create and configure a user account in Supply Chain Management

Authenticate by using a certificate or client secret

Quickstart: Register an application with the Microsoft identity platform

How to: Use the portal to create an Azure AD application and service principal that can access

resources

To enable Supply Chain Management to use your Azure AD application, follow these steps.

1. Create a user that corresponds to the user credentials for the Warehouse Management mobile app:

a. In Supply Chain Management, go to System administration > Users > UsersSystem administration > Users > Users .

b. Create a user.

c. Assign the warehousing mobile device user.

2. Associate your Azure AD application with the Warehouse Management mobile app user :

a. Go to System administration > Setup > Azure Active Director y applicationsSystem administration > Setup > Azure Active Director y applications .

b. Create a line.

c. Enter the client ID that you made a note of in the previous section, give it a name, and select the user

that you just created. We recommend that you tag all your devices. Then, if a device is lost, you can

easily remove its access to Supply Chain Management from this page.

Authentication with Azure AD provides a secure way of connecting a mobile device to Supply Chain

Management. You can authenticate by using either a client secret or a certificate. If you will import connection

settings, we recommend that you use a certificate instead of a client secret. Because the client secret must

always be stored securely, you can't import it from a connection settings file or a QR code, as described later in

this topic.

Certificates can be used as secrets to prove the application's identity when a token is requested. The public part

https://docs.microsoft.com/en-us/azure/active-directory/develop/quickstart-register-app
https://docs.microsoft.com/en-us/azure/active-directory/develop/howto-create-service-principal-portal


Configure the application by importing connection settings

Create a connection settings file or QR codeCreate a connection settings file or QR code

PA RA M ET ERPA RA M ET ER DESC RIP T IO NDESC RIP T IO N

ConnectionName Specify the name of the connection setting. The maximum
length is 20 characters. Because this value is the unique
identifier for a connection setting, make sure that it's unique
in the list. If a connection that has the same name already
exists on the device, it will be overridden by the settings
from the imported file.

ActiveDirectoryClientAppId Specify the client ID that you made a note of while you were
setting up Azure AD in the Create a web service application
in Azure Active Directory section.

ActiveDirectoryResource Specify the root URL of Supply Chain Management.

ActiveDirectoryTenant Specify the Azure AD tenant that you're using with the
Supply Chain Management server. This value has the form 
https://login.windows.net/<your-Azure-AD-tenant-ID> .

Here is an example: 
https://login.windows.net/contosooperations.onmicrosoft.com

.

Company Specify the legal entity in Supply Chain Management that
you want the application to connect to.

ConnectionType (Optional) Specify whether the connection setting should use
a certificate or a client secret to connect to an environment.
Valid values are "certificate" and "clientsecret". The default
value is "certificate".

IsEditable (Optional) Specify whether the app user should be able to
edit the connection setting. Valid values are "true" and
"false". The default value is "true".

of the certificate is uploaded to the app registration in the Azure portal, whereas the full certificate must be

deployed on each device where the Warehouse Management mobile app is installed. Your organization is

responsible for managing the certificate in terms of rotation and so on. You can use self-signed certificates, but

you should always use non-exportable certificates.

You must make the certificate available locally on each device where you run the Warehouse Management

mobile app. For information about how to manage certificates for Intune-controlled devices if you're using

Intune, see Use certificates for authentication in Microsoft Intune.

To make it easier to maintain and deploy the application on many mobile devices, you can import the

connection settings instead of manually entering them on each device. This section explains how to create and

import the settings.

You can import connection settings from either a file or a QR code. For both approaches, you must first create a

settings file that uses JavaScript Object Notation (JSON) format and syntax. The file must include a connection

list that contains the individual connections that have to be added. The following table summarizes the

parameters that you must specify in the connection settings file.

Note:Note:  Client secrets can't be imported.

https://docs.microsoft.com/en-us/mem/intune/protect/certificates-configure


IsDefault (Optional) Specify whether the connection is the default
connection. A connection that is set as the default
connection will automatically be preselected when the app is
opened. Only one connection can be set as the default
connection. Valid values are "true" and "false". The default
value is "false".

CertificateThumbprint (Optional) For Windows devices, you can specify the
certificate thumbprint for the connection. For Android
devices, the app user must select the certificate the first time
that a connection is used.

PA RA M ET ERPA RA M ET ER DESC RIP T IO NDESC RIP T IO N

{
    "ConnectionList": [
        {
            "ActiveDirectoryClientAppId":"aaaaaaaa-bbbb-ccccc-dddd-eeeeeeeeeeee",
            "ConnectionName": "Connection1",
            "ActiveDirectoryResource": "https://yourenvironment.cloudax.dynamics.com",
            "ActiveDirectoryTenant": "https://login.windows.net/contosooperations.onmicrosoft.com",
            "Company": "USMF",
            "IsEditable": false,
            "IsDefaultConnection": true,
            "CertificateThumbprint": "aaaabbbbcccccdddddeeeeefffffggggghhhhiiiii",
            "ConnectionType": "certificate"
        },
        {
            "ActiveDirectoryClientAppId":"aaaaaaaa-bbbb-ccccc-dddd-eeeeeeeeeeee",
            "ConnectionName": "Connection2",
            "ActiveDirectoryResource": "https://yourenvironment2.cloudax.dynamics.com",
            "ActiveDirectoryTenant": "https://login.windows.net/contosooperations.onmicrosoft.com",
            "Company": "USMF",
            "IsEditable": true,
            "IsDefaultConnection": false,
            "ConnectionType": "clientsecret"
        }
    ]
}

Save the connection settings file on each deviceSave the connection settings file on each device

The following example shows a valid connection settings file that contains two connections. As you can see, the

connection list (named "ConnectionList" in the file) is an object that has an array that stores each connection as

an object. Each object must be enclosed in braces ({}) and separated by commas, and the array must be enclosed

in brackets ([]).

You can either save the information as a JSON file or generate a QR code that has the same content. If you save

the information as a file, we recommend that you save it by using the default name, connections.json, especially

if you will store it in the default location on each mobile device.

Typically, you will use a device management tool or script to distribute the connection settings files to each

device that you're managing. If you use the default name and location when you save the connection settings file

on each device, the Warehouse Management mobile app will automatically import it, even during the first run

after the app is installed. If you use a custom name or location for the file, the app user must specify the values

during the first run. However, the app will continue to use the specified name and location afterward.

Every time that the app is started, it reimports the connection settings from their previous location to determine

whether there have been any changes. The app will update only connections that have the same names as the

connections in the connection settings file. User-created connections that use other names won't be updated.



NOTENOTE

Import the connection settingsImport the connection settings

You can't remove a connection by using the connection settings file.

As has been mentioned, the default file name is connections.json. The default file location depends on whether

you're using a Windows device or an Android device:

Windows:Windows: C:\Users\<User>\AppData\Local\Packages\Microsoft.WarehouseManagement_8wekyb3d8bbwe\LocalState

Android:Android: Android\data\com.Microsoft.WarehouseManagement\files

Usually, the paths are automatically created after the first run of the app. However, you can manually create

them if you must transfer the connection settings file to the device before installation.

If the app is uninstalled, the default path and its contents are removed.

Follow these steps to import connection settings from a file or a QR code.

1. Start the Warehouse Management mobile app on your mobile device. The first time that you start the

app, a welcome message is shown. Select Select a connectionSelect a connection.

2. If you're importing the connection settings from a file, and the default name and location were used when

the file was saved, the app might already have found the file. In this case, skip ahead to step 4. Otherwise,

select Set up connectionSet up connection, and then continue to step 3.

3. In the Connection setupConnection setup dialog box, select Add from fileAdd from file or Add from QR codeAdd from QR code, depending on how

you want to import the settings:

If you're importing the connection settings from a file, select Add from fileAdd from file, browse to the file on



your local device, and select it. If you select a custom location, the app will store it and automatically

use it the next time.

If you're importing the connection settings by scanning a QR code, select Add from QR codeAdd from QR code. The

app prompts you for permission to use the device's camera. After you give permission, the camera is

started, so that you can use it for scanning. Depending on the quality of the device's camera and the

complexity of the QR code, you might find it difficult to get a correct scan. In that case, try to reduce

the complexity of the QR code by generating only one connection per QR code. (Currently, you can

use only the device's camera to scan the QR code.)

4. When the connection settings are successfully loaded, the selected connection is shown.

5. If you're using an Android device and are using a certificate for authentication, the device prompts you to

select the certificate.



Manually configure the application

6. The app connects to your Supply Chain Management server and shows the sign-in page.

If you don't have a file or QR code, you can manually configure the app on the device so that it connects to the

Supply Chain Management server through the Azure AD application.

1. Start the Warehouse Management mobile app on your mobile device.

2. If the app is started in Demo modeDemo mode, select Connection settingsConnection settings . If the S ign-inSign-in page appears when the

app is started, select Change connectionChange connection.

3. Select Set up connectionSet up connection.



4. Select Input manuallyInput manually .

The New ConnectionNew Connection page appears and shows the settings that are required to manually enter the

connection details.

5. Enter the following information:

Use client secretUse client secret – Set this option to Yes to use a client secret to authenticate with Supply Chain

Management. Set it to No to use a certificate for authentication. (For more information, see the

Create a web service application in Azure Active Directory section earlier in this topic.)



Remove access for a device

IMPORTANTIMPORTANT

IMPORTANTIMPORTANT

Connection nameConnection name – Enter a name for the new connection. This name will appear in the SelectSelect

connectionconnection field the next time that you open the connection settings. The name that you enter

must be unique. (In other words, it must differ from all other connection names that are stored on

your device, if any other connection names are stored there.)

Active director y client IDActive director y client ID – Enter the client ID that you made a note of while you were setting

up Azure AD in the Create a web service application in Azure Active Directory section.

Active director y client secretActive director y client secret – This field is available only when the Use client secretUse client secret option

is set to Yes. Enter the client secret that you made a note of while you were setting up Azure AD in

the Create a web service application in Azure Active Directory section.

Active director y cer tificate thumbprintActive director y cer tificate thumbprint – This field is available only for Windows devices and

only when the Use client secretUse client secret option is set to No. Enter the certificate thumbprint that you

made a note of while you were setting up Azure AD in the Create a web service application in

Azure Active Directory section.

Active director y resourceActive director y resource – Specify the root URL of Supply Chain Management.

Don't end this value with a slash (/).

Active director y tenantActive director y tenant – Enter the Azure AD tenant that you're using with the Supply Chain

Management server. This value has the form https://login.windows.net/<your-Azure-AD-tenant-ID>

. Here is an example: https://login.windows.net/contosooperations.onmicrosoft.com .

Don't end this value with a slash (/).

CompanyCompany  – Enter the legal entity (company) in Supply Chain Management that you want the

application to connect to.

6. Select the SaveSave button in the upper-right corner of the page.

7. If you're using an Android device and are using a certificate for authentication, the device prompts you to

select the certificate.

8. The app connects to your Supply Chain Management server and shows the sign-in page.

If a device is lost or compromised, you must remove access to Supply Chain Management for it. The following

steps describe the recommended process for removing access.

1. Go to System administration > Setup > Azure Active Director y applicationsSystem administration > Setup > Azure Active Director y applications .

2. Delete the line that corresponds to the device that you want to remove access for. Make a note of the

client ID that is used for the device, because you will need it later.

If you've registered only one client ID, and multiple devices use the same client ID, you must push out new

connection settings to those devices. Otherwise, they will lose access.

3. Sign in to the Azure portal at https://portal.azure.com.

4. In the left navigation pane, select Active Director yActive Director y , and make sure that you're in the correct directory.

https://portal.azure.com/


NOTENOTE

5. In the ManageManage list, select App registrationsApp registrations , and then select the application to configure. The SettingsSettings

page appears and shows configuration information.

6. Make sure that the client ID of the application matches the client ID that you made a note of in step 2.

7. On the toolbar, select DeleteDelete.

8. In the confirmation message that appears, select YesYes .

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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IMPORTANTIMPORTANT

Turn on the mobile device user settings feature

Create and manage user settings

The new Warehouse Management mobile app has a set of app-specific settings that help tailor the user

experience. Because the app can be used on devices of different screen sizes and configurations (such as tablet,

phone, or arm-held), it can be useful to centrally manage these settings from Microsoft Dynamics 365 Supply

Chain Management.

The mobile device user settings feature lets you define global user settings that will be used on all devices. You

can also define more granular user settings for individual device brands, device models, and/or workers. When a

worker signs in to the Warehouse Management mobile app, the app fetches and applies the most specific

settings profile that is stored in Supply Chain Management for the matching brand, device, and/or user ID.

This feature can help workers get started more quickly whenever they begin to use a new device. Here are some

examples:

Admins can establish a standard set of preferences that work best for devices from a specific manufacturer

and/or for specific device models. Therefore, workers can get started with a new device without necessarily

having to change the settings.

If your company has a pool of identical devices that are shared among workers, workers will see their

preferred setup every time that they sign in, even if they have never used the specific physical device that

they selected on a given day.

In Supply Chain Management, admins can view and edit all stored settings, even for individual workers. This

capability can help them troubleshoot or fine-tune new features.

The mobile device user settings feature applies only to the new Warehouse Management mobile app. It doesn't work with

the old warehouse app.

Before you can use this feature, it must be turned on in your system. Admins can use the feature management

settings to check the status of the feature and turn it on. In the Feature managementFeature management workspace, the feature is

listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: User settings, icons, and step titles for the new warehouse app

Use the Mobile device user settingsMobile device user settings  page to create, view, and manage settings profiles at all levels of

granularity. The first time that a worker edits their user settings on a new device, a new profile is automatically

added on this page, if it doesn't already exist. That profile is then updated every time that the worker makes a

change.

You can also define a settings profile that applies to all device brands, device models, and/or workers. You can

then increase the granularity by applying more specific settings for individual brands, models, and/or workers.

Follow these steps to create and manage user settings for your mobile devices.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/mobile-device-user-settings.md


Create and manage mobile device brands

1. Go to Warehouse management > Mobile device > Mobile device user settingsWarehouse management > Mobile device > Mobile device user settings .

2. Select an existing user settings profile in the list pane to open its record. Alternatively, select NewNew  on the

Action Pane to create a new profile.

Each profile in the list pane is labeled to indicate the brand, model, and/or user ID that the profile applies

to. More general profiles have a value of All for some or all of these characteristics.

3. In the header section of the record for the new or selected settings profile, set the following fields:

Device brand nameDevice brand name – Select the device brand name that the profile should apply to. If the profile

should apply to all brands, leave this field blank. The list of values includes all the brands that have

been defined in your system. For information about how to define the list of brands, see the next

section.

Device model IDDevice model ID – Select the device model that the profile should apply to. If the profile should

apply to all models of the selected brand, leave this field blank. The list of values includes all the

models that have been defined for the brand that is selected in the Device brand nameDevice brand name field. For

information about how to define the list of models for each brand, see the next section.

User IDUser ID – Select the user ID of the warehouse worker that the setting profile should apply to. If the

profile should apply to all workers, leave this field blank.

4. On the GeneralGeneral  FastTab, set the following fields:

Button positionButton position – Select how buttons should be positioned on the device. Elements in the app will be

moved to better fit the preference or handedness of the worker. The available options are Bottom right

(default), Bottom left, Top right, and Top left.

Display or ientationDisplay or ientation – Select the display orientation that should be applied by default in the app.

Scan with cameraScan with camera – Set this option to Yes to use the device camera to scan input fields where the

preferred input mode is set to Scanning. If your device has a built-in scanner, set this option to No to

use the scanner instead.

Show product photoShow product photo – Select whether product photos should be shown if they are available for the

released product. For more information about how to add product images, see Add an image to a

product.

Display color themeDisplay color theme – Select a color theme for the device.

Sound levelSound level  – Select the sound level for the device. Select a value between 0 (zero) and 10. A value of

0 represents no sound, and a value of 10 represents maximum volume. The default value is 4.

Vibration levelVibration level  – Select the vibration level for the device. Select a value between 0 (zero) and 5. A

value of 0 represents no vibration, and a value of 5 represents maximum vibration. The default value

is 1.

Text scale percentageText scale percentage – Specify the text size as a percentage of the standard size. Enter a value

between 70 and 400. A value of 70 represents the smallest text scale, and a value of 400 represents

the largest text scale. The default value is 100.

Button scale percentageButton scale percentage – Specify the button size as a percentage of the standard size. Enter a

value between 50 and 200. A value of 50 represents the smallest button scale, and a value of 200

represents the largest button scale. The default value is 100.

Use the Mobile device brandsMobile device brands  page to view, create, and manage the device brands and models that can be

used with your settings profiles. The mobile app automatically fetches and submits the local brand name and

model ID the first time that a worker edits their settings on a given device. Therefore, most of these records will

usually be automatically generated. However, you can also manage all the records on this page. For example,

you can give more useful descriptions to each brand and model to help distinguish similar or cryptic model IDs.



Follow these steps to create and manage your mobile device brands and models.

1. Go to Warehouse management > Mobile device > Mobile device brandsWarehouse management > Mobile device > Mobile device brands .

2. In the list pane, select a mobile device brand to open its record. Alternatively, select NewNew  on the Action

Pane to create a new brand.

3. In the header section of the record for the new or selected device brand, set the following fields:

Device brand nameDevice brand name – The brand name of the device, such as Microsoft Corporation.

Descr iptionDescr iption – You can enter a description to help distinguish brand names.

4. The Mobile device modelsMobile device models  FastTab shows all the models for the selected device brand. Use the buttons

on the toolbar to add rows to the grid or remove rows. For each row, you can set the following fields:

Device model IDDevice model ID – The device model ID, such as Surface Book 2.

Descr iptionDescr iption – You can enter a description to help distinguish model IDs.
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NOTENOTE

NOTENOTE

System requirements

NOTENOTE

Get the warehouse app

This topic describes how to configure the old warehouse app. If you're looking for information about how to configure the

new Warehouse Management mobile app (currently in public preview), see Install and connect the Warehouse

Management mobile app.

This topic describes how to configure the warehouse app for cloud deployments. If you're looking for information about

how to configure the warehouse app for on-premises deployments, see Warehousing for on-premises deployments.

The warehouse app is available from Google Play Store and Microsoft Store. It's provided as a standalone

component. Therefore, you must download it on each device and then configure it to connect to your Microsoft

Dynamics 365 Supply Chain Management environment.

This topic explains how to install the warehouse app on each of your mobile devices and configure it to connect

to your Supply Chain Management environment. You can configure each device manually, or you can import

connection settings through a file or by scanning a QR code.

The warehouse app is available for both Windows and Android operating systems. To use the latest version of

the app, you must have one of the following operating systems installed on your mobile devices:

Windows 10 (Universal Windows Platform [UWP]) Fall creators update 1709 (build 10.0.16299) or later

Android 4.4 or later

If you must support older Windows devices that can't run the latest version of Windows, you can still download version

1.6.3.0 of the warehouse app from Microsoft Store. That version will run on Windows 10 (UWP) November Update 1511

(build 10.0.10586) or later. However, be aware that this version of the warehouse app doesn't support mass deployment

of connection settings. Therefore, you must manually configure the connection on each device that runs this version of

the app.

Use one of the following links to download the app:

Windows (UWP):Windows (UWP): Dynamics 365 for Finance and Operations - Warehousing on Microsoft Store

Android:Android: Warehousing - Dynamics 365 on Google Play Store

For smaller deployments, you might want to install the app from the relevant store on each device and then

manually configure the connection to the environments that you're using. However, in version 1.7.0.0 and later

of the warehouse app, you can also automate app deployment and/or configuration. You might find this

approach convenient if you manage many devices, and you're using a mobile device management and mobile

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/install-configure-warehousing-app.md
file:///T:/eiye/ac1a/dynamics365/dev-itpro/deployment/warehousing-for-on-premise-deployments.html
https://www.microsoft.com/store/apps/9p1bffd5tstm
https://play.google.com/store/apps/details?id=com.Microsoft.Dynamics365forOperationsWarehousing


     Create a web service application in Azure Active Directory

application management solution such as Microsoft Intune. For information about how to use Intune to add

applications, see Add apps to Microsoft Intune.

To enable the warehouse app to interact with a specific Supply Chain Management server, you must register a

web service application for the Supply Chain Management tenant in Azure Active Directory (Azure AD). The

following procedure shows one way to complete this task. For detailed information and alternatives, see the

links after the procedure.

1. In a web browser, go to https://portal.azure.com.

2. Enter the name and password of the user who has access to the Azure subscription.

3. In the Azure portal, in the left navigation pane, select Azure Active Director yAzure Active Director y .

4. Make sure that you're working with the instance of Azure AD that is used by Supply Chain Management.

5. In the ManageManage list, select App registrationsApp registrations .

https://docs.microsoft.com/en-us/mem/intune/fundamentals/what-is-intune
https://docs.microsoft.com/en-us/mem/intune/apps/apps-add
https://portal.azure.com/


6. On the toolbar, select New registrationNew registration to open the Register an applicationRegister an application wizard.

7. Enter a name for the application, select the Accounts in this organizational director y onlyAccounts in this organizational director y only  option,

and then select RegisterRegister .

8. Your new app registration is opened. Make a note of the Application (client) IDApplication (client) ID value, because you will

need it later. This ID will be referred to later in this topic as the client ID.



9. In the ManageManage list, select Cer tificate & secretsCer tificate & secrets . Then select one of the following buttons, depending on

how you want to configure the app for authentication. (For more information, see the Authenticate by

using a certificate or client secret section later in this topic.)

Upload cer tificateUpload cer tificate – Upload a certificate to use as a secret. We recommend this approach, because

it's more secure and can also be automated more completely. If you're running the warehouse app on

Windows devices, make a note of the ThumbprintThumbprint value that is shown after you upload the

certificate. You will need this value when you configure the certificate on Windows devices.

New client secretNew client secret – Create a key by entering a key description and a duration in the PasswordsPasswords

section, and then select AddAdd. Make a copy of the key, and store it securely.

For more information about how to set up web service applications in Azure AD, see the following resources:

For instructions that show how to use Windows PowerShell to set up web service applications in Azure

AD, see How to: Use Azure PowerShell to create a service principal with a certificate.

For complete details about how to manually create a web service application in Azure AD, see the

following topics:

Quickstart: Register an application with the Microsoft identity platform

https://docs.microsoft.com/en-us/azure/active-directory/develop/howto-authenticate-service-principal-powershell
https://docs.microsoft.com/en-us/azure/active-directory/develop/quickstart-register-app


 

Create and configure a user account in Supply Chain Management

Authenticate by using a certificate or client secret

How to: Use the portal to create an Azure AD application and service principal that can access

resources

To enable Supply Chain Management to use your Azure AD application, follow these steps.

1. Create a user that corresponds to the user credentials for the warehouse app:

a. In Supply Chain Management, go to System administration > Users > UsersSystem administration > Users > Users .

b. Create a user.

c. Assign the warehousing mobile device user.

2. Associate your Azure AD application with the warehouse app user :

a. Go to System administration > Setup > Azure Active Director y applicationsSystem administration > Setup > Azure Active Director y applications .

b. Create a line.

c. Enter the client ID that you made a note of in the previous section, give it a name, and select the user

that you just created. We recommend that you tag all your devices. Then, if they are lost, you can

easily remove their access to Supply Chain Management from this page.

Authentication with Azure AD provides a secure way of connecting a mobile device to Supply Chain

Management. You can authenticate by using either a client secret or a certificate. If you will import connection

settings, we recommend that you use a certificate instead of a client secret. Because the client secret must

always be stored securely, you can't import it from a connection settings file or a QR code, as described later in

this topic.

Certificates can be used as secrets to prove the application's identity when a token is requested. The public part

of the certificate is uploaded to the app registration in the Azure portal, whereas the full certificate must be

deployed on each device where the warehouse app is installed. Your organization is responsible for managing

https://docs.microsoft.com/en-us/azure/active-directory/develop/howto-create-service-principal-portal


Configure the application by importing connection settings

Create a connection settings file or QR codeCreate a connection settings file or QR code

PA RA M ET ERPA RA M ET ER DESC RIP T IO NDESC RIP T IO N

ConnectionName Specify the name of the connection setting. The maximum
length is 20 characters. Because this value is the unique
identifier for a connection setting, make sure that it's unique
in the list. If a connection that has the same name already
exists on the device, it will be overridden by the settings
from the imported file.

ActiveDirectoryClientAppId Specify the client ID that you made a note of while you were
setting up Azure AD in the Create a web service application
in Azure Active Directory section.

ActiveDirectoryResource Specify the root URL of Supply Chain Management.

ActiveDirectoryTenant Specify the Azure AD tenant that you're using with the
Supply Chain Management server. This value has the form 
https://login.windows.net/<your-Azure-AD-tenant-ID> .

Here is an example: 
https://login.windows.net/contosooperations.onmicrosoft.com

.

Company Specify the legal entity in Supply Chain Management that
you want the application to connect to.

ConnectionType (Optional) Specify whether the connection setting should use
a certificate or a client secret to connect to an environment.
Valid values are "certificate" and "clientsecret". The default
value is "certificate".

IsEditable (Optional) Specify whether the app user should be able to
edit the connection setting. Valid values are "true" and
"false". The default value is "true".

the certificate in terms of rotation and so on. You can use self-signed certificates, but you should always use

non-exportable certificates.

You must make the certificate available locally on each device where you run the warehouse app. For

information about how to manage certificates for Intune-controlled devices if you're using Intune, see Use

certificates for authentication in Microsoft Intune.

To make it easier to maintain and deploy the application on many mobile devices, you can import the

connection settings instead of manually entering them on each device. This section explains how to create and

import the settings.

You can import connection settings from either a file or a QR code. For both approaches, you must first create a

settings file that uses JavaScript Object Notation (JSON) format and syntax. The file must include a connection

list that contains the individual connections that have to be added. The following table summarizes the

parameters that you must specify in the connection settings file.

Note:Note:  Client secrets can't be imported.

https://docs.microsoft.com/en-us/mem/intune/protect/certificates-configure


IsDefault (Optional) Specify whether the connection is the default
connection. A connection that is set as the default
connection will automatically be preselected when the app is
opened. Only one connection can be set as the default
connection. Valid values are "true" and "false". The default
value is "false".

CertificateThumbprint (Optional) For Windows devices, you can specify the
certificate thumbprint for the connection. For Android
devices, the app user must select the certificate the first time
that a connection is used.
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{
    "ConnectionList": [
        {
            "ActiveDirectoryClientAppId":"aaaaaaaa-bbbb-ccccc-dddd-eeeeeeeeeeee",
            "ConnectionName": "Connection1",
            "ActiveDirectoryResource": "https://yourenvironment.cloudax.dynamics.com",
            "ActiveDirectoryTenant": "https://login.windows.net/contosooperations.onmicrosoft.com",
            "Company": "USMF",
            "IsEditable": false,
            "IsDefaultConnection": true,
            "CertificateThumbprint": "aaaabbbbcccccdddddeeeeefffffggggghhhhiiiii",
            "ConnectionType": "certificate"
        },
        {
            "ActiveDirectoryClientAppId":"aaaaaaaa-bbbb-ccccc-dddd-eeeeeeeeeeee",
            "ConnectionName": "Connection2",
            "ActiveDirectoryResource": "https://yourenvironment2.cloudax.dynamics.com",
            "ActiveDirectoryTenant": "https://login.windows.net/contosooperations.onmicrosoft.com",
            "Company": "USMF",
            "IsEditable": true,
            "IsDefaultConnection": false,
            "ConnectionType": "clientsecret"
        }
    ]
}

Save the connection settings file on each deviceSave the connection settings file on each device

The following example shows a valid connection settings file that contains two connections. As you can see, the

connection list (named "ConnectionList" in the file) is an object that has an array that stores each connection as

an object. Each object must be enclosed in braces ({}) and separated by commas, and the array must be enclosed

in brackets ([]).

You can either save the information as a JSON file or generate a QR code that has the same content. If you save

the information as a file, we recommend that you save it by using the default name, connections.json, especially

if you will store it in the default location on each mobile device.

Typically, you will use a device management tool or script to distribute the connection settings files to each

device that you're managing. If you use the default name and location when you save the connection settings file

on each device, the warehouse app will automatically import it, even during the first run after the app is

installed. If you use a custom name or location for the file, the app user must specify the values during the first

run. However, the app will continue to use the specified name and location afterward.

Every time that the app is started, it reimports the connection settings from their previous location to determine

whether there have been any changes. The app will update only connections that have the same names as the

connections in the connection settings file. User-created connections that use other names won't be updated.



NOTENOTE

Import the connection settingsImport the connection settings

You can't remove a connection by using the connection settings file.

As has been mentioned, the default file name is connections.json. The default file location depends on whether

you're using a Windows device or an Android device:

Windows:Windows: 
C:\Users\<User>\AppData\Local\Packages\Microsoft.Dynamics365forOperations-
Warehousing_8wekyb3d8bbwe\LocalState

Android:Android: Android\data\com.Microsoft.Dynamics365forOperationsWarehousing\files

Usually, the paths are automatically created after the first run of the app. However, you can manually create

them if you must transfer the connection settings file to the device before installation.

If the app is uninstalled, the default path and its contents are removed.

Follow these steps to import connection settings from a file or a QR code.

1. Open the warehouse app on your mobile device.

2. Go to Connection settingsConnection settings .

3. Set the Use demo modeUse demo mode option to No.

4. Select Select fileSelect file or Scan QR codeScan QR code, depending on how you want to import the settings:

If you're importing the connection settings from a file, the app might already have found the file if the

default name and the default location were used when it was saved. Otherwise, select Select fileSelect file,

browse to the file on your local device, and select it. If you select a custom location, the app will store it

and automatically use it the next time.

If you're importing the connection settings by scanning a QR code, select Scan QR codeScan QR code. The app

prompts you for permission to use the device's camera. After you give permission, the camera is

started, so that you can use it for scanning. Depending on the quality of the device's camera and the

complexity of the QR code, you might find it difficult to get a correct scan. In that case, try to reduce

the complexity of the QR code by generating only one connection per QR code. (Currently, you can

use only the device's camera to scan the QR code.)



5. When the connection settings are successfully loaded, select the BackBack (left arrow) button in the upper-left

corner of the page.

6. If you're using an Android device and are using a certificate for authentication, the device prompts you to

select the certificate.



 Manually configure the application

7. The app connects to your Supply Chain Management server and shows the sign-in page.

You can manually configure the app on the device so that it connects to the Supply Chain Management server

through the Azure AD application.

1. Open the warehouse app on your mobile device.

2. Go to Connection settingsConnection settings .

3. Set the Use demo modeUse demo mode option to No.



4. Tap in the Select connectionSelect connection field to expand the settings that are required to manually enter the

connection details.

5. Enter the following information:

Use client secretUse client secret – Set this option to Yes to use a client secret to authenticate with Supply Chain

Management. Set it to No to use a certificate for authentication. (For more information, see Create

a web service application in Azure Active Directory.)

Connection nameConnection name – Enter a name for the new connection. This name will appear in the SelectSelect

connectionconnection field the next time that you open the connection settings. The name that you enter

must be unique. (In other words, it must differ from all other connection names that are stored on

your device, if any other connection names are stored there.).

Active director y client IDActive director y client ID – Enter the client ID that you made a note of while you were setting

up Azure AD in the Create a web service application in Azure Active Directory section.

Active director y client secretActive director y client secret – This field is available only when the Use client secretUse client secret option

is set to Yes. Enter the client secret that you made a note of while you were setting up Azure AD in

the Create a web service application in Azure Active Directory section.



Remove access for a device

NOTENOTE
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Active director y cer tificate thumbprintActive director y cer tificate thumbprint – This field is available for Windows devices only

when the Use client secretUse client secret option is set to No. Enter the certificate thumbprint that you made a

note of while you were setting up Azure AD in the Create a web service application in Azure Active

Directory section.

Active director y resourceActive director y resource – Specify the root URL of Supply Chain Management.

Don't end this value with a slash (/).

Active director y tenantActive director y tenant – Enter the Azure AD tenant that you're using with the Supply Chain

Management server. This value has the form https://login.windows.net/<your-Azure-AD-tenant-ID>

. Here is an example: https://login.windows.net/contosooperations.onmicrosoft.com .

Don't end this value with a slash (/).

CompanyCompany  – Enter the legal entity in Supply Chain Management that you want the application to

connect to.

6. Select the SaveSave button in the upper-right corner of the page.

7. If you're using an Android device and are using a certificate for authentication, the device prompts you to

select the certificate.

8. The app connects to your Supply Chain Management server and shows the sign-in page.

In the event of a lost or compromised device, you must remove access to Supply Chain Management for the

device. The following steps describe the recommended process for removing access.

1. Go to System administration > Setup > Azure Active Director y applicationsSystem administration > Setup > Azure Active Director y applications .

2. Delete the line that corresponds to the device that you want to remove access for. Make a note of the

client ID that is used for the removed device, because you will need it later.

If you've registered only one client ID, and multiple devices use the same client ID, you must push out new

connection settings to those devices. Otherwise, they will lose access.

3. Sign in to the Azure portal at https://portal.azure.com.

4. In the left navigation pane, select Active Director yActive Director y , and make sure that you're in the correct directory.

5. In the ManageManage list, select App registrationsApp registrations , and then select the application to configure. The SettingsSettings

page appears and shows configuration information.

6. Make sure that the client ID of the application matches the client ID that you made a note of in step 2.

7. On the toolbar, select DeleteDelete.

8. In the confirmation message that appears, select YesYes .

https://portal.azure.com/
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Scan bar codes using a camera in the warehouse
app
2/18/2021 • 2 minutes to read • Edit Online

Prerequisites

Setup

Supported bar code formats

Navigation

This topic explains how to set up the warehouse app to scan bar codes using a camera on a mobile device.

To use this feature, you need to have version 1.2.0.0 of the warehouse app installed, and your device must have

a camera. When you open the app after updating, you will be prompted to allow the app to use the camera. If

your device doesn’t have a camera, no prompt will be shown, and you will not be able to use a camera as a

scanner.

In the Display settings of the warehouse application, you can select if the camera should be used for bar code

scanning. If you enable Use the camera as scannerUse the camera as scanner , you can use the camera on every input field that has the

preferred input mode set to ScanningScanning.

To control whether an input field should be scannable, on the Warehouse app field namesWarehouse app field names  page, set

Preferred input modePreferred input mode to ScanningScanning. When this option is selected, a camera can be used for scanning in the

warehouse app. For information about how to configure app field names in Warehousing, see Configure app

field names in warehouse app.

The most common bar code formats are supported, including Code 128, Code 39, Code 93, EAN-8, EAN-13,

UPC-E, UPC-A, and QR codes.

The camera page will be initiated on each page where the input field has the preferred input mode set to

Scanning, when you are on the Camera page use the following options to navigate:

Click the back button to go back to the Task and details page.

Click the pencil on the Task and details page to go to the page where you can type input manually.

Click the camera on the Task and details page to go back to the Camera page.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/scan-bar-codes-using-a-camera.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/supply-chain/warehousing/configure-app-field-names-priorities-warehouse
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On the camera page, when you click the Camera button, it will appear dimmed while trying to identify a bar

code. If a bar code is not identified within 5 seconds, the process will time out and the Camera button will

become available again. You will then be able to try to scan a bar code again.

When you aim the camera at a bar code, keep the bar code aligned within the brackets for best result. When a

bar code is scanned successfully, the result will be processed, and you will be taken to the next step. If the next

step contains another input field with the preferred input mode set to Scanning, the camera page will start

again. If the next step is not a scanning field, then the camera page will not be initiated.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Configure warehouse app field names
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Preferred input mode This option defines whether a scanning field or a manual
entry input field should be shown for the selected field
name. This is useful to distinguish fields depending on if
barcodes are used for the field. Note:Note:  For field names with
preferred input mode set to ScanningScanning, you can enter
information manually if the barcode is unreadable or
damaged.

Input type This option defines what input type should be used for the
selected field name. Four options are available:

Configure warehouse app field priority

This topic describes how to define and configure warehouse app field names and priorities in Dynamics 365

Supply Chain Management.

This topic applies to features in Warehouse management. It doesn’t apply to features in Inventory management.

Warehousing is an application that you can use to perform warehouse tasks. You can define and configure the field names

that are used in the app, as well as configure the priority to which the field names should be assigned. This topic explains

how to define and configure these warehouse app field names and priorities, and how they are used in Warehousing. For

detailed information about how to configure the connection to FWarehousing, refer to the tutorial Install and configure

the warehouse app overview.

When you use Warehousing on your mobile device, you can configure how metadata should be displayed on

your device on the Warehouse app field namesWarehouse app field names  page. In a new company, select Create default setupCreate default setup to

generate all field names that will be used in the warehouse mobile device workflows, and then assign a

preferred input mode and input type to them. After you have generated all field names, you can select the

following input options.

SelectionSelection - Contains a list of options to choose
from. Field names with this option are not editable.

DateDate - Field names specified as date will show a date
format with the label. This helps warehouse workers
see in which format to enter the date. Field names
with this option are not editable.

AlphaAlpha - If selected, the device keyboard will be used
when entering information manually in the app. The
keyboard experience can be changed depending on
which device is used.

NumericNumeric - For field names that use numeric input
only, you can select this option to display a custom
numeric keypad with the input field instead of the
device keyboard.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/configure-app-field-names-priorities-warehouse.md
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Priority 10

Priority 20

Priority 30

Priority 40

Priority 50

Additional resources

On the Warehouse app field pr ior ityWarehouse app field pr ior ity  page, you can put field names into different priority groups. This makes

it possible to decide what information should be displayed on the main task page when warehouse workers

perform tasks using the app. If you click Create default setupCreate default setup, a default set of priority groups will be

generated. It is possible to create as many priority groups as needed, but only three priority groups will be

shown on the task page. When the system sends metadata to the app, it will assign each field a relative priority

depending on its priority group, and the app will display the first three priority groups contained in the

metadata on the task page. The rest of the overflowing metadata will be displayed on a secondary details page.

The following table shows an example of five priority groups.

Item

Quantity

Unit of measure

Cluster position

Cluster

Item description

Configuration

Color

Size

Style

Location

License plate

For example, when a warehouse worker is performing a task on a mobile device, if the metadata that will be

displayed in the app consists of the following fields:

Item

Quantity

Unit of measure

Item description

Size and Location

Based on the warehouse app field priority set up in the table above, the following 3 rows of information will be

displayed on the task page:

Row 1: Item, Quantity, Unit of measure

Row 2: Item description

Row 3: Size

The remaining metadata, for example, Location, will not be displayed on the task page, but will be displayed on a

details page. To learn more and see examples of the user interface, refer to the blog post Announcing Finance

and Operations - Warehousing.

Install and configure the warehouse app overview

https://blogs.msdn.microsoft.com/dynamicsaxscm/2017/01/20/announcing-dynamics-365-for-operations-warehousing/


NOTENOTE
Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839


Set up mobile devices for warehouse work
2/18/2021 • 23 minutes to read • Edit Online

NOTENOTE

NOTENOTE

Configure menu items for activities and inquiries
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None This default value doesn't enable an activity or inquiry.

About View information about the system, such as the version
number, the warehouse ID, and the worker who is currently
logged on.

Change warehouse Change the warehouse that a worker is logged on to.

This topic describes how to configure the menu items that warehouse workers use to perform work on a mobile

device.

This topic applies to features in Warehouse management. It doesn't apply to features in Inventory management. The

menu items that appear on the menus on a warehouse mobile device are configured on the Mobile device menuMobile device menu

itemsitems page. Because the menu items can be put onto different menus, it's easy to configure menu structures so that only

specific types of work are exposed to specific users. You can configure menu items to perform the following tasks:

Process an inquiry or perform an activity, such as printing a label, generating license plate numbers, starting

a production order, or quickly looking up information about items in a location.

Create work that will be performed through another process. For example, receiving an item for a purchase

order can create put-away work for another worker.

Perform work that was created by another process (existing work), such as put-away work that was created

when an item was received for a purchase order.

To create a menu item for an activity or inquiry, set the ModeMode field to IndirectIndirect. A list of Activity codeActivity code options

then becomes available, so that you can select the type of inquiry or activity that the menu item is for. To create a

menu item to generate warehouse work, set the ModeMode field to WorkWork . A list of Work creation processWork creation process  options

then becomes available. To create a menu item to process existing warehouse work, set the ModeMode field to WorkWork ,

and then set the Use existing workUse existing work option to YesYes .

Additional fields might be available for menu items, depending on the mode that you select for the menu item, and

whether the menu item is used to perform existing work. For information about the additional field selections, see the

“Additional menu item options” section later in this topic.

If the ModeMode field for a menu item is set to IndirectIndirect, you can create a menu item to perform a general activity or

inquiry that doesn't create work. Examples include reprinting license plate labels and an inquiry about the items

in a location. The following table lists the options that are available.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/configure-mobile-devices-warehouse.md


Location inquiry View information about all items and quantities for a
location.

License plate inquiry View the quantity of items on a license plate and the
location of the license plate.

Start production order Start a production order.

Production scrap Enter the quantity of scrap that was created during
production for each bill of materials (BOM) line.

Production last pallet Indicate that the last pallet of items has been produced for a
production order, and that the status of the production
order must be updated to Repor ted as finishedRepor ted as finished. The
status of the raw materials that were not consumed during
production is change back from PickedPicked to On orderOn order , and
the items can be returned to inventory.

Item inquiry Scan an item to determine where it is in the warehouse. The
inquiry returns all locations and quantities for the scanned
item.

Reprint label Reprint a license plate label.

License plate build Create a parent license plate by combining multiple license
plates in the same location. This option is useful if you move
multiple license plates at the same time. After the parent
license plate is moved, you must perform a license plate
break before you can pick items from each license plate.

License plate break Break up a license plate build so that you can pick items
from the license plates that were in the build.

Driver check in If you’re using Transportation management, register the
arrival of a driver by scanning the outbound load ID,
appointment ID, or shipment ID. For this option, a load must
be assigned to the appointment, and the status of the load
must be LoadedLoaded.

Driver check out Register that a driver has completed his or her appointment.

Flush number sequence cache Delete number sequence numbers from the number
sequence cache. This activity is typically performed by a
system administrator to resolve caching issues when mobile
devices are used.

Change batch disposition Allow a worker to specify a batch disposition code for an
item and batch. This selection updates the disposition code
that is specified for the batch.
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Tip:Tip:  To move a parent license plate, you must use a
mobile device that is configured to create work for
movements.



Display open work list Show a list of available work to a particular user. The user
can then select work to perform and will be directed to it.
This list is intended to be viewed on tablet devices that have
a screen size of 7 inches or more. When you select this
option, the Edit quer yEdit quer y  and Field listField list  menu items become
available. The Edit quer yEdit quer y  page lets you set up criteria for
the work that appears in the list. The Field listField list  page lets
you select what fields appear in the work list. For example,
you can reduce the number of fields that appear, so that the
user can more quickly select the most appropriate work
item. On the GeneralGeneral FastTab, in the Records per pageRecords per page
field, you can also select how many work records are shown
per page. If the Allow users to filter work byAllow users to filter work by
transaction typetransaction type option is selected, the work list will
include a Filter workFilter work control that the user can use to filter
by transaction type. In the work list, users will see only work
that they have permission to access. You must make sure
that users have permission for one or more user-directed
menu items that support the specific work class types that
they should be able to access. Permissions are verified when
a user tries to perform work from the list.

Create transfer order from license plates Allows warehouse workers create and process transfer
orders directly from the warehouse app. The warehouse
workers start by selecting the destination warehouse and
can then scan one or more license plates using the app.
When the warehouse worker selects Complete orderComplete order , a
batch job will create the required transfer order and order
lines based on the on-hand inventory registered for those
license plates. For more information, see Create transfer
orders from the warehouse app
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Configure menu items to create work for another worker or process
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Purchase order Purchase order line receiving Register the receipt of a quantity of an
item by using the purchase order
number and purchase order line
number, and create put-away work for
another worker.

Purchase order line receiving and put
away

Register the receipt of a quantity of an
item by using the purchase order
number and purchase order line
number, and put the items away. The
same worker performs both actions.

You can set up a menu item that creates work for another worker after an initial action is performed on the

mobile device. For example, when one worker uses a mobile device to receive an item, put-away work is created

for another worker. To set up a menu item that creates work, on the Mobile device menu itemsMobile device menu items page, in the

ModeMode field, select WorkWork . In the following table, the options in the Work creation processWork creation process  field are arranged

by work order type.



Purchase order item receiving Register the receipt of a quantity of an
item for a purchase order by
registering the purchase order number
and item number, and create put-away
work for another worker.

Purchase order item receiving and put
away

Register the receipt of a quantity of an
item for a purchase order by
registering the purchase order number,
and put the item away. The same
worker performs both actions.

License plate receiving Receive an inbound advance ship
notice (ASN) by using the license plate
ID.

License plate receiving and put away Receive and put away an inbound
advance ship notice (ASN) by using the
license plate ID.

Load item receiving Register the receipt of a quantity for a
load by using the load ID, and create
put-away work for another worker. The
item number and product dimensions
match the receipt to the purchase
order lines.

Load item receiving and put away Register the receipt of a load by using
the load ID, and put the items away.
The item number and product
dimensions match the receipt to the
purchase order lines. The same worker
performs both actions.

Return order Return order receiving Register the receipt of a quantity of an
item by registering the RMA number,
and create put-away work for another
worker.

Return order receiving and put away Register the receipt of a quantity of an
item by registering the RMA number,
and put the items away. The same
worker performs both actions.

Transfer order Transfer order item receiving Register the receipt of a quantity of an
item, and create put-away work for
another worker.

Note:Note:  Use this option only if the
items were shipped from a
warehouse that isn't enabled for
warehouse management
processes.



Transfer order item receiving and put
away

Register the receipt of a quantity of an
item, and put the items away. The
same worker performs both actions.

Transfer order line receiving Register the receipt of a quantity of an
item, and create put-away work for
another worker.

Transfer order line receiving and put
away

Register the receipt of a quantity of an
item, and put the items away. The
same worker performs both actions.

License plate receiving Receive an inbound advance ship
notice (ASN) by using the license plate
ID.

License plate receiving and put away Receive and put away an inbound
advance ship notice (ASN) by using the
license plate ID.

Production Report as finished Register a quantity of a finished item
that has been finished for a
production, and create put-away work
for another worker. The quantity can
be some or all of the quantity that was
planned for production.

Report as finished and put away Register a quantity of a finished item
that has been finished for a
production, and put the items away.
The quantity can be some or all of the
quantity that was planned for
production. The same worker performs
both actions.

Kanban Indicate that a kanban is completed,
and create put-away work for another
worker.

Kanban put away Indicate that a kanban is completed,
and put away the items. The same
worker performs both actions.

Inventory Movement Register that items have been moved
from one location to another. The
worker specifies the location that the
items are moved from and where they
are moved to.

Quarantine Change the status of the on-hand
inventory for a license plate or location
to make damaged or missing
inventory items unavailable.

Note:Note:  Use this option only if the
items were shipped from a
warehouse that isn't enabled for
warehouse management
processes.



Movement by template Move items from one location to
another in a semi-automated manner.
The worker selects the location to
move items from, the system uses the
location directive to determine where
to move the items to.

Warehouse transfer Register that items have been
transferred from one warehouse to
another. This option requires that the
worker be allowed to perform work in
both warehouses.

License plate loading Use this option when you're setting up
your warehouse for the first time. Scan
all the license plates in all locations in
the warehouse. The locations must be
license plate–controlled. You can't use
this option if Serial numberSerial number  or BatchBatch
numbernumber  is listed above LocationLocation in
the inventory reservation hierarchy.

Cycle count Adjustment in Increase the quantity of items in
inventory. Specify the location, license
plate, item, quantity, unit of measure,
and status.

Adjustment out Reduce the quantity of items in
inventory. Specify the location, license
plate, item, quantity, unit of measure,
and status of the inventory.

Spot cycle counting Start a count for a location. The worker
must count all items in the location.
When the result of a count is less than
the expected quantity, the missing
quantity is considered a loss.

Configure menu items to process existing work
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None This default value doesn't process work.

Note:Note:  This menu item requires a
default inventory transfer journal
where the Voucher drawVoucher draw field is
set to PostingPosting.

In addition to setting up menu items to create warehouse work, you can set up menu items to process work that

has already been created. Set the ModeMode field to WorkWork , and select the Use existing workUse existing work option. Some

additional options then become available on the GeneralGeneral  tab. You can control access to the menu item by

assigning one or more work classes on the Work classWork class  FastTab. The work classes define the work that the menu

item can process. The work class can also be used to grant access to specific user roles or to separate processing

for different types of operations. The following table describes the options that are available. The option can be

chosen under the Directed byDirected by  field in the Mobile device menu itemsMobile device menu items page.



System directed Supply Chain Management controls the type of work that is
assigned to a worker and the order that the worker
performs the work in. When you select this option, you can
sekect System-directed workSystem-directed work on the Action Pane to open
the System-directed sor ting orderSystem-directed sor ting order  page, where you can
set up sorting criteria for the work. The sorting criteria
control the order that the worker performs the work in. You
can add as many criteria as you require.

User directed The worker selects the work to perform and the order to
perform it in.

User grouping The worker manually groups work. This option is useful
when, for example, a worker can pick multiple items at the
same time in a location. After the worker has finished picking
all the required items, he or she can put the items away.

System grouping Supply Chain Management groups work for the worker,
based on a specified field. For example, picking work is
grouped when a worker scans a shipment ID, load ID, or any
value that can link each work unit. If you select this option,
the following fields are required:

Validated user directed The worker selects the work to perform when work is
associated with a larger entity, such as a load or shipment.
The worker determines the order that the items are picked
in. If you select this option, the following fields are required:

This option is useful when, for example, multiple pallets are
staged for a load. If you select LoadIdLoadId in the ValidatedValidated
User DirectedUser Directed field, the worker can pick any pallet that is
associated with the load. The worker receives an error
message if he or she scans an item that isn't associated with
the load.

Cluster picking The worker groups work into clusters. Clusters lets workers
pick items from a single location for multiple work orders at
the same time.

Cycle count grouping The worker selects a zone, work pool, or location, and Supply
Chain Management assigns work, based on the selection. If
you select this option, you can click Cycle countingCycle counting on the
Action Pane to specify additional information to display, and
you can also specify the number of times that the worker
must repeat the count if a difference is found.
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System grouping fieldSystem grouping field – Select the field that the
worker scans to group the work.

System grouping labelSystem grouping label – Enter text to instruct the
worker what to scan to group the work.

Validated user directed fieldValidated user directed field – Select the field
that the worker scans to group the work.

Validated user directed labelValidated user directed label – Enter text that
instructs the worker what to scan when picking work
is grouped by the system.



Transport loading This feature allows several warehouse workers to load
inventory from the same or different loads onto the same
truck, with loads that are fully or partially shipped.

O P T IO NO P T IO N DESC RIP T IO NDESC RIP T IO N

Additional menu item options

F IEL DF IEL D DESC RIP T IO NDESC RIP T IO N

Allow splitting of work Select this option to let users put items for a work order into
more than one target license plate. This option is useful
when, for example, a target license plate is full, and the
worker must add the remaining items to another license
plate. The worker can select FullFull to indicate that the license
plate is full and stop receiving picking work for it. The put
location for the picked items is then displayed, and the
picking work that has already been completed is moved to a
new work order. The remaining picking work for the target
license plate stays on the original work order.

Anchoring Select this option to let workers specify a location that
overrides the suggested staging or loading location. All the
remaining put-away work is directed to the new location.
This option is useful when, for example, a worker who must
put items for order 1 in a staging location by Dock 1 can’t,
because a previous load hasn’t cleared the location. Instead
of waiting for the Dock 1 staging location to become
available, the worker can decide to use the staging location
for Dock 2. In this case, the worker overrides the suggested
staging location. The put location for all remaining items for
the work order is then updated to the Dock 2 staging
location. If you select this option, you must set the AnchorAnchor
byby field.

Anchor by If you're using anchoring, you must specify whether to
anchor by shipment or by load.

Audit template ID Select the work audit template that will interrupt the work
process for this menu item so that another operation can be
performed. For example, if this menu item is for inbound
work, the audit template might require that the worker
check the temperature in the delivery container. The point at
which the process is interrupted is specified on the audit
template. This point can be, for example, when work is
started or completed, or when its status changes.

Cluster profile ID Select the cluster profile to use for cluster picking. The cluster
profile includes settings such as whether to create clusters
automatically, the names of positions and the number of
work units that they can be assigned, when to break clusters
into individual units, and whether verification is required.
This field is available only if Cluster pickingCluster picking is selected in
the Directed byDirected by  field.

Additional menu items options are available on the Mobile device menu itemsMobile device menu items page. The options vary,

depending on the process that you’re configuring the menu item for.

The following table describes these options.



Count total item quantity first Select this option to require that a worker count the total
quantity first during a count. If a difference is found, the
worker must provide additional information, such as the
license plate number, batch number, and serial numbers.

Create movement Select this option to let a worker create work for a
movement, but without requiring that the worker perform
the work immediately. This option is useful if, for example, a
quality inspection has been completed, and the inspector
wants the item to be moved from the quality inspection
area.

Directive code To use a specific location directive, select the directive code
that is associated the location directive. This field is available
when you create work and the work creation process is
Movement by templateMovement by template.

Disable cycle count thresholds Select this option to ignore the cycle count thresholds. If you
select this option, cycle count work isn't created when
threshold values are exceeded.

Display batch disposition code Select this option to display batch disposition codes. For
example, you can display batch disposition codes when you
receive a returned batch. Workers can then evaluate the
status or quality of a batch, and select the appropriate code.
The rules on the batch disposition code determine whether
the batch will be available to other warehouse processes. If
you don't select this option, one of the following batch
disposition codes is used:

Display disposition code Select this option to display disposition codes. For example,
you can display disposition codes when you receive return
items. Workers can then evaluate the status or quality of the
items, and select the appropriate code. The rules on the
disposition code determine whether the items will be
available to other warehouse processes.

Display inventory status Select this option to display the status of items in inventory.
This option is available for all menu items that use existing
work, except cycle counting.

Display summary of pick screen Select this option to display a summary of picking work for
the selected work order. The summary is displayed until the
first work line is processed for the work order.

Generate license plate Select this option to generate a unique license plate number,
based on the number sequence selection. For example, you
can generate a license plate number for items that are
received for purchase orders.
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If you receive a new batch number, the default batch
disposition code that is specified on the item model
group.

The batch disposition code that is already assigned to
the batch.



Group put away Select this option to group the put-away work. This option is
available when the work was grouped either by the worker
or by Supply Chain Management. When the worker has
finished all the picking work in the group, put-away work is
created for the same group.

Inventory adjustment types Select the inventory adjustment type that determines the
inventory counting journal that is used to post the
adjustment, and whether to remove reservations. This field is
available only for the Adjustment inAdjustment in or Adjustment outAdjustment out
work creation process.

Override batch number Select this option to let workers who are reporting a
quantity as finished for a production order enter a batch
number that differs from the batch number that is assigned
to the production order.

Override target license plate Select this option to let workers specify a target license plate
number that differs from the suggested target license plate.
Use this option when the first pick for a work order is for the
entire quantity of an item on a license plate. This option is
useful when, for example, a pallet is reused.

Pick and pack Select this option to let workers combine work for a sales
order or load into a single work unit. A worker can perform
work only for the sales order or load. This option is useful
when, for example, you must increase a quantity for a sales
order after the load, shipment, and work have been created
for the sales order. This option is available when the menu
item uses existing work, and the work is directed by the user
or system.

Pick oldest batch Indicate whether the worker must pick the oldest batch in a
location first. The following options are available:

Print label Select this option to let workers print license plate labels.

System grouping field Select the field that determine how Supply Chain
Management will group picking work for workers. For
example, if you select the ShipmentIdShipmentId field, the worker will
scan the shipment ID to group the picking work. All work for
the shipment is then assigned to the worker. This field
requires that you create a menu item to use existing work
that is grouped by the system. You must also enter text in
the System grouping labelSystem grouping label field to instruct the worker
what to scan.
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NoneNone – The worker can pick any batch in the
location. The worker receives no message.

WarnWarn – The worker can pick any batch in the
location, but he or she receives a warning message if
a batch isn't the oldest batch.

ForceForce – The worker must pick the oldest batch in the
location. The worker receives an error message if a
batch isn't the oldest batch. Note:Note:  This option is
relevant only if Batch numberBatch number  is lower than
LocationLocation in the reservation hierarchy that is
assigned to the item.



System grouping label Enter the text that will instruct the worker what to scan
when picking work is grouped by Supply Chain
Management. For example, if you're using the ShipmentIdShipmentId
field to group picking work by shipment, you might enter
Shipment IDShipment ID in the field. This field requires that you create
a menu item to use existing work that is grouped by the
system. You must also select the field to group by in the
System groupingSystem grouping field.

Use default data Select this option to enable the Default dataDefault data button on the
Action Pane, where you can select fields to display data that
a worker typically requires in his or her daily work. This
option is useful if, for example, a worker often picks items
from the same location. You can select the From locationFrom location
field to display the location by default.

Validated User Directed Field Select the field that the worker will scan to group the work.
For example, if you select LoadIdLoadId, a worker can pick any
work that is associated with a selected load. You must also
enter text in the Validated User Directed LabelValidated User Directed Label field to
instruct the worker what to scan.

Validated User Directed Label Enter the text that will instruct the worker what to scan
when picking work is grouped by a validated user-directed
field. For example, if you’re using the LoadIdLoadId field to group
picking work for a load, you might enter Load IDLoad ID in the
field.

Work template code Select the work template that will create the work for a
process. For example, if you receive an item for a purchase
order, the put-away work will be generated based on the
work template. If you don't select a work template, Supply
Chain Management assigns a template, based on query
criteria. For more information about work templates, see
Controlling warehouse work with work templates and
location directives.

Show work line list Select an option for how workers will be able to view and
interact with the lines for the currently selected picking work.
For more information about this option, see Set up a mobile
device menu item to provide a pick line overview.
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Require workers to confirm the product, location, or quantity when
they pick items
You can set up work confirmations that require that a worker use a mobile device to register the location or

quantity when they perform work in the warehouse. Work confirmations help ensure that the worker is at the

correct location or is handling the correct quantity of items. You can also enable Supply Chain Management to

automatically confirm the worker ’s registration. If you enable automatic confirmation, you can't also require

confirmations for location or quantity. Work confirmations also include products and product variants.

Additionally, you can register confirmations by scanning a bar code. To confirm products and product variants,

you must enter an ID for the product or product variant. This ID can be a product ID, product search ID, external

ID, GTIN, or bar code. After you enter the ID or scan the bar code, the dimensions for the product variant are

displayed on the mobile device.

The following table describes the various work types that you can use work confirmations with.
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Pick Require confirmation when items are picked.

Put Require confirmation when items are put in a location.

Counting Require confirmation during cycle counting.

Adjustments Require confirmation when inventory quantities are adjusted.

Custom Require confirmation for custom work.

Quarantine Require confirmation when items are moved to quarantine.

License plate building Require confirmation when items are consolidated to build a
license plate.

Print Require confirmation when license plate labels are printed.

Status change Require confirmation when the status of inventory is
changed.

NOTENOTE

Additional resources

NOTENOTE

You can require product confirmation only for pick and put work types.

Set up a mobile device menu item for completing work of type Purchase order

Set up a mobile device menu item to register received items

Inventory statuses
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Enable the Process warehouse app events feature

Set up a batch job to process warehouse app events
Process warehouse app eventsProcess warehouse app events

Query warehouse app events

The standard event queue process

Batch jobs running in Supply Chain Management can use data from a queue for processing events issued by the

warehouse app to react as needed to the signaled events. This feature add relevant events to the queue in

response to certain types of actions taken by workers using the app. An example is when using the Create andCreate and

process transfer orders from the warehouse appprocess transfer orders from the warehouse app feature, the transfer order header and lines get created

and updated in the back end when the system is running the Process warehouse app eventsProcess warehouse app events  batch job.

Before you can use this feature, it must be enabled on your system. Administrators can use the feature

management page to check the feature status and enable it if needed. The Process warehouse app events

feature is listed as:

ModuleModule - Warehouse management

Feature nameFeature name - Process warehouse app events

Set up a scheduled batch job to process the warehouse app events for the transfer order creation and line

updates.

1. Go to Warehouse management > Periodic tasks > Process warehouse app eventsWarehouse management > Periodic tasks > Process warehouse app events .

2. The Process warehouse app events dialog box opens. Expand the Run in backgroundRun in background FastTab and set

Batch processingBatch processing to YesYes .

3. On the Run in the backgroundRun in the background FastTab, select RecurrenceRecurrence.

4. The Define recurrenceDefine recurrence dialog box opens. Set the run schedule as needed for your business.

5. Select OKOK to return to the Process warehouse app eventsProcess warehouse app events  dialog box.

6. Select OKOK in the Process warehouse app eventsProcess warehouse app events  dialog box to add the batch job to the batch queue.

You can view the event queue and events messages generated by the warehouse app by going to WarehouseWarehouse

management > Inquir ies and repor ts > Mobile device logs > Warehouse app eventsmanagement > Inquir ies and repor ts > Mobile device logs > Warehouse app events .

The warehouse apps events queue will typically be used with the following described flow:

1. An event gets added to the queue with an event message. The new message initially has an Event state of

WaitingWaiting, which means that the Process warehouse app eventsProcess warehouse app events  batch job will not pick up and process this

message.

2. As soon as the message state is updated to QueuedQueued, the Process warehouse appProcess warehouse app events batch job will

pick up and process the event.

3. The batch job updates the event states to either CompletedCompleted or FailedFailed, depending on whether the requested

process was possible.

4. When all the related event messages are CompletedCompleted, the event is deleted from the queue.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/warehouse-app-events.md


Handle event errors
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For a detailed example, see Create transfer order from warehouse app process.

As part of the warehouse event processing, the requested message activity may not receive processes from the

batch job. In this case, the event message will change to FailedFailed. You can use the Batch logBatch log information to learn

why and take needed action to correct any problems.

For a detailed example, see Create transfer order from warehouse app.

To reset a failed warehouse app event message:

1. Go to Warehouse management > Inquir ies and repor ts > Mobile device logs > Warehouse appWarehouse management > Inquir ies and repor ts > Mobile device logs > Warehouse app

eventsevents .

2. On the Warehouse app event messagesWarehouse app event messages  FastTab, find and select a relevant event that is showing FailedFailed in

the Event stateEvent state column.

3. Select ResetReset from the Warehouse app event messagesWarehouse app event messages  toolbar.

4. Continue working until all relevant messages are reset.

You can also remove a FailedFailed event message by using the DeleteDelete option on the Warehouse app eventWarehouse app event

messagesmessages  toolbar.
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Warehousing mobile device app processing

Work policies

Work policies with work creationWork policies with work creation

Work policies without work creationWork policies without work creation

This topic explains how to set up the warehouse app so that it supports using a license plate receiving process to

receive physical inventory.

You can use this functionality to quickly record the receipt of inbound inventory that is related to an advance

ship notice (ASN). The system automatically creates an ASN when warehouse management processes are used

to ship a transfer order. For the purchase order process, an ASN can be manually recorded, or it can be

automatically imported by using an inbound ASN data entity process.

The ASN data is linked to loads and shipments via the packing structures, where pallets (parent license plates)

can contain cases (nested license plates).

To reduce the number of inventory transactions when packing structures that have nested license plates are used, the

system records the physical on-hand inventory on the parent license plate. To trigger the movement of the physical on-

hand inventory from the parent license plate to the nested license plates, based on the packing structure data, the mobile

device must provide a menu item that is based on the Pack to nested license plates work creation process.

When a worker scans an incoming license plate ID, the system initializes a license plate receiving process. Based

on this information, the content of the license plate (data coming from the ASN) gets physically registered at the

inbound dock location. The flows that follow will depend your business process needs.

As with (for example) the Report as finished mobile device menu item process, the license plate receiving

process supports several workflows based on the defined setup.

When you register incoming items using a work policy that creates work, the system generates and saves put-

away work records for each registration. If you use the License plate receiving and put away work process, then

registration and put away are handled as a single operation using a single mobile device menu item. If you use

the License plate receiving process, then the receiving and put-away processes are handled as two different

warehouse operations, each with their own mobile device menu item.

You can use the license plate receiving process without creating work. If you define work policies that have a

work order type of Transfer receipt and/or Purchase orders, and you use the process for License plate receiving

(and put away), the following two Warehousing mobile app processes won't create work. Instead, they will just

register the inbound physical inventory on the license plate at the inbound receiving dock.

License plate receiving

License plate receiving and put away

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/warehousing-mobile-device-app-license-plate-receiving.md
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Receive inventory on a location that doesn't track license platesReceive inventory on a location that doesn't track license plates

Add mobile device menu items for each receiving location in a
warehouse

Show or skip the receiving summary page

Prevent transfer order–shipped license plates from being used at
warehouses other than the destination warehouse

You must define at least one location for a work policy in the Inventor y locationsInventor y locations section. You can't specify the same

location for multiple work policies.

The Print labelPrint label option for Warehousing mobile device menu items won't print a license plate label without work

creation.

To make this functionality available on your system, you must turn on the License plate receiving enhancements

feature in feature management.

It's possible to use a warehouse location that is assigned to a location profile even when Use license plateUse license plate

trackingtracking isn't turned on. Therefore, when you receive inventory, you can directly register the on-hand inventory

on a location without work creation.

The License plate receiving enhancements feature lets you receive at any location in a warehouse by adding

location-specific license plate receiving (and put away) menu items to the Warehousing mobile app. Previously,

the system supported receiving only at the default location that is defined for each warehouse. However, when

this feature is turned on, mobile device menu items for license plate receiving (and put away) now provide the

Use default dataUse default data option, which lets you select a custom "to" location for each menu item. (This option was

already available for some other types of menu items.)

To make this functionality available on your system, you must turn on the License plate receiving enhancements

feature in feature management.

You can use the Control whether to display a receiving summary page on mobile devices feature to take

advantage of an additional detailed Warehouse app flow as part of the license plate receiving process.

When this feature is turned on, mobile device menu items for license plate receiving or license plate receiving

and put-away will provide a Display receiving summar y pageDisplay receiving summar y page setting. This setting has the following options:

Display a detailed summar yDisplay a detailed summar y  – During license plate receiving, workers will see an extra page that shows

the full ASN information.

Skip the summar ySkip the summar y  – Workers won't see the full ASN information. Warehouse workers also won't be able to

set a disposition code or add exceptions during the receiving process.

To make this functionality available on your system, you must turn on the Control whether to display a receiving

summary page on mobile devices feature in feature management.

A license plate receiving process can't be used if an ASN contains a license plate ID that already exists and has

physical on-hand data at a warehouse location other than the warehouse location where the license plate

registration occurs.

For transfer order scenarios where the transit warehouse doesn't track license plates (and therefore also doesn't

track physical on-hand inventory per license plate), you can use the Prevent transfer order shipped license

plates from being used on other warehouses than the destination warehouse feature to prevent physical on-
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hand updates of license plates that are in transit.

To make this functionality available on your system, you must turn on the Prevent transfer order shipped license

plates from being used on other warehouses than the destination warehouse feature in feature management.

To manage the functionality when this feature is available, follow these steps.

1. Go to Warehouse management > Setup > Warehouse management parametersWarehouse management > Setup > Warehouse management parameters .

2. On the GeneralGeneral  tab, on the L icense platesLicense plates  FastTab, set the Transit warehouse license plate policyTransit warehouse license plate policy

field to one of the following values:

Allow reuse of non-tracked license plateAllow reuse of non-tracked license plate – The system works the same way that it works when

the Prevent transfer order shipped license plates from being used on other warehouses than the

destination warehouse feature isn't available. This value is the default setting when you first activate

the feature.

Prevent reuse of non-tracked license platePrevent reuse of non-tracked license plate – Only on-hand updates that are related to a shipped

license plate will be allowed at the destination warehouse until the transfer order has been received.

For more information about mobile device menu items, see Set up mobile devices for warehouse work.

For more information about the Report as finished production scenario, see the Warehouse work policies

overview.

For more information about inbound load management, see Warehouse handling of inbound loads for purchase

orders.
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Create a mobile device menu item

This topic shows how to set up a Mobile device menu item. In this example, the menu item is used for

performing work of type Purchase order. The work class that's associated with the menu item determines which

work is valid. You can use this guide in demo data company USMF. This procedure is typically carried out by a

warehouse manager.

1. Go to Mobile device menu itemsMobile device menu items by entering it in the search bar.

2. Select NewNew .

3. In the Menu item nameMenu item name field, type a value. Enter a unique value. For example, you could type POMove .

Remember the value, you'll need it later.

4. In the TitleTitle field, type a value. This is the title which will be displayed on the mobile device. For example, you

could type PO Move .

5. In the ModeMode field, select WorkWork .

6. Select YesYes  in the Use existing workUse existing work field.

7. In the Directed byDirected by  field, select System groupingSystem grouping. When you select something in the Directed byDirected by  field,

additional fields appear in the GeneralGeneral  section on this page. The fields that appear depend on what you

selected. When you select System groupingSystem grouping, two new fields are added. These are explained below.

8. In the System groupingSystem grouping field, select WorkPoolIdWorkPoolId. When warehouse workers open this menu item, they'll

be asked to scan a Work pool ID. All work orders with this Work pool ID and open work order lines with one

of the work classes added to this menu item will be pushed to the user.

9. In the System grouping labelSystem grouping label  field, type a value. This is the text displayed to the user on the mobile device.

For example, you could type Work poolWork pool .

10. Select YesYes  in the Overr ide license plate during putOverr ide license plate during put field. This option allows warehouse workers to

override the target license plate when items are put down on a license plate controlled location.

11. Select YesYes  in the Group put awayGroup put away  field.

12. Expand the Work classesWork classes  section.

13. Select NewNew .

14. In the Work class IDWork class ID field, type Purchase . The work pool restricts the work that the menu item can be used

for. In this case it will be used for open work order lines that have the Purchase work class ID.

15. Select SaveSave.

This mobile device menu item is used to perform existing work. Therefore you must set this value to

YesYes .

The Display inventor y statusDisplay inventor y status  field determines whether the inventory status of the on-hand

inventory will be displayed to the warehouse worker on the mobile device.

If all the Put lines on the work order share the same location, the user will receive one combined Put

instruction for all lines.

Audit template ID: A work audit template allows you to specify that the work process for a menu item

should be interrupted so that another operation can be performed. For example, if this menu item is

for inbound work, the audit template might require that the worker checks the temperature. The point

at which the process is interrupted is specified on the audit template and can be, for example, when

work is started or completed, or when its status changes.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/tasks/set-up-mobile-device-menu.md


Set up work confirmation

Add the menu item to a mobile device menu
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1. Select Work confirmation setupWork confirmation setup.

2. In the Work typeWork type field, select PickPick .

3. Select the Auto confirmAuto confirm check box. The work instruction with work type Pick will be auto-confirmed. This

instruction will not be presented to the user.

4. Select NewNew .

5. In the Work typeWork type field, select 'Put'.

6. Select the Location confirmationLocation confirmation check box. The warehouse worker will be asked to perform a

confirmation scan of the location, when the item is put down.

7. Select SaveSave.

1. Go to Mobile deviceMobile device menu by entering it in the search bar.

2. Select EditEdit.

3. Use the Quick Filter to find records. For example, filter on the NameName field with a value of inboundinbound. You want

to find the menu you use for inbound menu items. In USMF this is called InboundInbound.

4. In the tree, select a valuea value.

5. Select the arrow that points to the right.

6. Select SaveSave.

7. Close the page.
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Create a mobile device menu item

This topic focuses on the setup of a mobile device menu item. This menu item is used for registration of the

receipt of items ordered via purchase orders.

You can use this guide in demo data company USMF. This procedure is intended for the warehouse manager.

1. In the navigation pane, go to Modules > Warehouse management > Setup > Mobile device >Modules > Warehouse management > Setup > Mobile device >

Mobile device menu itemsMobile device menu items .

2. Select NewNew .

3. In the Menu item nameMenu item name field, type a value. This is the unique identifier for this mobile device menu item.

For example, you could type My PO registration .

4. In the TitleTitle field, type a value. This is the title, which will be displayed to the user on the mobile device. For

example, you could type PO registration .

5. In the ModeMode field, select WorkWork . Registration of on-hand quantities received for a purchase order line will

create work to move the items from the receiving area into the inventory. Work isn't created until the items

are registered. Therefore, leave the Use existing workUse existing work option set to NoNo.

6. In the Work creation processWork creation process  field of the GeneralGeneral  section, select Purchase order item receivingPurchase order item receiving.

A purchase order line must be uniquely identified before on-hand can be registered in the warehouse.

In this scenario, the mobile device will register the purchase order number and item number, and this

will allow the system to identify the PO line. Put away work will be created and can be picked up by

another worker. The work creation method that you select determines which fields become available

on the GeneralGeneral  FastTab.

If you select the Use default dataUse default data option, the Default dataDefault data button is enabled. Here you can select

fields to display data that a worker typically needs in their daily work, so that these values are shown

on the mobile device.

The L icense plate groupingLicense plate grouping parameter works in combination with the unit sequence group that's

assigned to the item that's being received. You can specify whether receipts of less than or more than

one pallet should be grouped into one license plate, or divided into a separate license plate for each

unit.

If you select the Generate license plateGenerate license plate option, this generates a unique license plate number based

on the number sequence selection.

You can select the template that will be used when work is created. For example, if you register an item

for a purchase order, the put away work will be generated based on the work template. If you don't

select a work template here, the system will assign a template based on the query criteria that are

associated with the templates.

If disposition codes are displayed on the mobile device, workers can evaluate the status or quality of

the items, and select the appropriate code. The rules for the disposition code determine whether the

items will be available to other warehouse processes. The rules also determine which location

directive is used for the work that's created.

If you select the Batch disposition codesBatch disposition codes  option, workers can evaluate the status or quality of a

batch, and select the appropriate disposition code. The rules that are set on the batch disposition code

determine whether the batch will be available to other warehouse processes.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/tasks/set-up-mobile-device-menu-item-register-received-items.md
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7. Select SaveSave.

8. Close the page.

If you select the Pr int labelsPr int labels  option, a license plate label will be printed automatically when items are

received.

1. In the navigation pane, go to Modules > Warehouse management > Setup > Mobile device >Modules > Warehouse management > Setup > Mobile device >

Mobile device menuMobile device menu.

2. Use the Quick FilterQuick Filter  to filter on the NameName field with a value of inbound .

3. Select EditEdit.

4. In the Available menus and items tree, select the menu item that you created before.

5. Select the arrow that points to the right.

6. Select SaveSave.

7. Close the page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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IMPORTANTIMPORTANT

Turn on the Work pick line overview feature

Configure menu items to show a list of all work lines

Some or all of the functionality noted in this topic is available as part of a preview release. The content and the

functionality are subject to change. For more information about preview releases, see One version service updates FAQ.

This topic explains how to configure options that are related to the pick line overview for mobile device menu

items that are used to process picking work. The pick line overview lets warehouse workers view and select

from a list of all the work lines that are related to their current task. This capability can help workers optimize

their picking sequence. The feature provides options that replace the standard SkipSkip button that lets workers

cycle through the lines one at a time, in a fixed order. (However, the option to use that button is still available.)

Admins can configure each menu item individually to control how, when, and where the warehouse app

presents the pick line overview.

Before you can use this feature, it must be turned on in your system. Admins can use the feature management

settings to check the status of the feature and turn it on if it's required. In the Feature managementFeature management

workspace, the feature is listed in the following way:

Module:Module: Warehouse management

Feature name:Feature name: Work pick line overview

To set up a mobile device menu item to provide a pick line overview, follow these steps.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu itemsWarehouse management > Setup > Mobile device > Mobile device menu items .

2. Select or create a menu item that is related to picking work, and set the following values:

Mode:Mode: Work

Use existing work :Use existing work : Yes

Directed by:Directed by: User directed or System directed

For more information about how to create menu items and use the various settings that are available on

the Mobile device menu itemsMobile device menu items page, see Set up mobile devices for warehouse work.

3. On the GeneralGeneral  FastTab, configure the feature by setting the Show work line listShow work line list field to one of the

following values:

Show only upon requestShow only upon request – Workers can choose to view the pick line list by selecting the Skip toSkip to

button in the warehouse app.

Show at the star t of ever y pickShow at the star t of ever y pick  – Workers see the list every time that they start or finish a pick

line. They can also view the list again by selecting the Skip toSkip to button in the warehouse app.

Show at the star t of the first pick onlyShow at the star t of the first pick only  – Workers see the list every time that they start new

picking work, but not after each line. They can also view the list again by selecting the Skip toSkip to button

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/pick-line-overview.md
https://docs.microsoft.com/en-us/dynamics365/unified-operations/fin-and-ops/get-started/one-version
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in the warehouse app.

Never showNever show  – The standard SkipSkip button appears in the warehouse app, and display of the work line

list is turned off. The SkipSkip button lets workers cycle through the lines one at a time, in a fixed order.

They can also cycle through the list as many times as they require, until all lines have been processed.

4. On the Action Pane, select SaveSave.

If you set the Show work line listShow work line list field to any value except Never show, the Field listField list button on the

Action Pane becomes available.

5. On the Action Pane, select Field listField list.

6. On the Field listField list page, configure the information that the warehouse app shows for each line in the list.

The Pr imar y controlPr imar y control  field is always set to LineNum. Therefore, each row in the list begins with a line

number.

Use the remaining Display fieldDisplay field fields to add up to seven additional display fields, as you require. In

each Display fieldDisplay field field, select the name of a work line field. Each line will then show a value for that

field. The values will be shown in the order that you select here. You can leave some of the DisplayDisplay

fieldfield fields blank if you don't require all seven values.

7. On the Action Pane, select SaveSave, and then close the Field listField list page.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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This procedure shows you how to create a mobile device menu item for license plate consolidation work. This

enables warehouse workers to consolidate items on one license plate with items on another license place within

the same location. For example, they might use this if subsequent staging steps were the same on both work

orders, so that the work only needs to be performed once for the merged items. You can use this procedure in

demo data company USMF. The task would typically be carried out by a warehouse manager. This procedure is

for a feature that was added in Dynamics 365 for Operations, version 1611.

1. Go to Warehouse management > Setup > Mobile device > Mobile device menu items.

2. Click New.

3. In the Menu item name field, type a value.

4. In the Title field, type a value.

5. In the Mode field, select 'Indirect'.

6. In the Activity code field, select 'Consolidate license plates'.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Where it applies

How to set up mixed license plate receiving

NOTENOTE

Mixed license plate receiving allows you to build a license plate consisting of multiple items before you register

and create put-away work.

A license plate that consists of multiple items does not have to be split at the receiving dock for you to register

each item.

When using an item-related flow to identify the source document lines, you can scan bar codes on the item

control. If the bar code has a quantity and a unit of measure (UOM) configured on it, the item and quantity will

automatically be added to the mixed license plate, and you will be returned to the screen to scan another item.

This allows you to quickly scan all the items without having to make a confirmation at each step.

In the flow for mixed license plate receiving, you can display the list of items that are already scanned to the

license plate and from here you can modify or correct the quantity of an item.

Mixed license plate receiving is a mobile device receiving flow to register and create work for multiple

lines/items at the same time. This is useful if you receive inbound license plates with multiple items.

Mixed license plate receiving is set up as a mobile device menu item.

You need to create a new menu item with mode work that does not use existing work and use one of the

following methods:

Mixed license plate receiving

Mixed license plate receiving and put away

The options to identify the source document lines are purchase order item, purchase order line, return order,

transfer order item, and transfer order line. These options can change the receiving order on a single license

plate. The last option is by load item. You can add multiple items to a license plate, but you cannot switch

between multiple loads.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Where it applies

Set up Display older batches within warehouse

NOTENOTE

The Display older batches within warehouseDisplay older batches within warehouse configuration lets you display a list of locations with batches

older than the current location of the work line. The list of locations that are displayed includes information

about the older batches in the location with the expiration date and the physical inventory of each batch. You can

choose to pick from a new location or to continue picking from the current location.

Pick from a new location - If you select a new location to pick from, the current work line will be updated to

use the new location and work will continue as usual with the new location. For the new location to be valid,

it must have enough available quantity for the whole work line. If the required quantity is not available, the

work line will not be updated, and the list will display.

Continue picking from the current location - If you continue with the current work line location, the quantities

for the work line will continue to be picked from the original location.

Display older batches within warehouse is configured on mobile device menu items and affects the pick for

batch below items.

The Display older batches within warehouseDisplay older batches within warehouse configuration is available on mobile device menu items when

the Pick oldest batchPick oldest batch option is set to WarnWarn.

Under Warehouse managementWarehouse management > SetupSetup > Mobile deviceMobile device > Mobile device menu itemsMobile device menu items , set UseUse

existing workexisting work to YesYes  for the menu item, and select WarnWarn in the Pick oldest batchPick oldest batch field.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Where it applies

How to set up the configuration for Pick oldest batch

NOTENOTE

You can access the configuration Pick oldest batchPick oldest batch via a mobile device menu and it allows you to force or

warn warehouse workers to pick the oldest batch in their current location.

Pick oldest batch is configured on mobile device menu items and effects the pick for batch below items.

For items that are set to use existing work, Pick oldest batchPick oldest batch can be set to NoneNone, WarnWarn, or ForceForce from a

mobile device menu.

NoneNone: Workers will not receive any messages and they will be allowed to pick any batch in their location.

WarnWarn and ForceForce: A list of the batch(es) with the oldest expiration date will be displayed above the batch control

when the worker selects a batch. If the location is license plate controlled, a list of license plates that have the

oldest batch will be displayed above the license plate control.

WarnWarn: If a worker chooses a license plate or batch that is not on the shown list, the control will be blanked

and a warning will be shown that there is an older batch to select. To be allowed to continue the work, the

worker can select the same license plate or batch again.

ForceForce: Workers will continue to receive the message that there is an older batch to pick.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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Overview of the existing design

This topic provides information about the process guide framework for developers who are extending the

warehouse mobile processes in X++. The warehouse mobile processes are extensible as a result of the

processes being broken into small steps. The business logic and user interface building of each step has been

extracted into individual classes, which allows for extensibility.

The warehouse mobile execution flows are exposed through a single custom service endpoint. The request

arrives from the mobile app in the form of an XML string, which contains the metadata of the user interface

presented in the mobile app, as well as the values entered by the user.

When the request is received, the first step is to deserialize this XML. The

WHSMobileAppSer viceXMLTranslatorWHSMobileAppSer viceXMLTranslator  class converts the XML into a container, which contains both the

control information, as well as session information.

Following this, the information in the container is used to deduce which warehouse process the user is working

on, or about to start (represented by the WHSWorkExecuteModeWHSWorkExecuteMode enumeration), and accordingly instantiate a

derived class of WHSWorkExecuteDisplayWHSWorkExecuteDisplay . The displayform()displayform()  method is invoked, which then does the

following:

Processes the data from the user (delegated to the WHSRFControlDataWHSRFControlData class, but some processes

implement specific logic by overriding the processControl()processControl()  method).

Executes business logic.

Increments the step.

Builds the container representing the new user interface (typically in a build…()build…()  method).

The container is then returned to the translator, which then serializes the XML, and sends it back as a response to

the mobile device.

The following sequence diagram shows an overview of the execution flow. Note that the diagram is more of a

schematic overview and is not a 1:1 representation of the actual code.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/process-guide-framework.md
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The above design offers a very simple framework for building processes used in mobile flows. However, as is

evident above, the displayform()displayform()  methods take over multiple responsibilities. It does delegate them to other

methods and classes, but in the absence of concrete class responsibilities, it is done in an inconsistent manner

across classes. Also, as the number of supported scenarios grows organically, some of those classes can become

quite complex. To make matters more interesting, some of those classes/methods are overridden and re-used in

multiple modes. The result is extremely long methods with high cyclomatic complexity. These have posed

maintenance issues in the past. Fixing bugs in these methods has been risky and regression prone. For example,

the processWorkLine()processWorkLine()  method in the WhsWorkExecuteDisplayWhsWorkExecuteDisplay  class is referred from multiple processes

(basically, anywhere where work execution is performed).

To make these extensible, one of the options would be to split the displayFormdisplayForm methods into smaller methods

and introduce extensibility points. However, because of the scenario matrix, it would be challenging for partners

to write extensions and validate against regressions. Not only that, because of the lack of structured

responsibility distribution noted above, the code would keep growing in unpredictable ways over time, posing

challenges in building quality extensions.

As a result, the redesign is the sustainable option, with a goal to have clearly defined classes having independent

responsibilities. A class should have one responsibility, one reason to change, and one reason to be extended.

In the redesigned framework, the core strategy revolves around two principles: divide the execution flow into

individual components with well-defined responsibilities and have well-defined extension points in each of the

components.

The name for the new framework is “ProcessGuide”. This is because the aim of these classes is to guide a user

through a business process (as opposed to the rich client which is a form-based experiences where the user has

more flexibility in how they interact with the data or in which order they perform tasks).

One notable detail is the deliberate omission of the “WHS” prefix. While the mobile processes were initially introduced for

warehousing, subsequently they have transcended boundaries to support various production and inventory management

processes. As a result, the warehouse reference was excluded in the name of the framework.



To identify the components, the first step is to look at the Production Start process

(WhsWorkExecuteDisplayProdStar tWhsWorkExecuteDisplayProdStar t class). Here is a schematic of the process.

Looking at the control flow, the following are components needed:

A controller to stitch through the entire business process.

A step responsible for execution of a step in the process.

A data processor for processing the data in a step.

A page builder responsible for building the user interface for a step.

A navigation agent responsible for step transition.

A class responsible for executing the business process.

In the process flow diagram above, if you begin at step 1 and start processing the data from the previous step,

and then end with building a UI, data would continue to be processed in the next step. This introduces a tight

coupling between consecutive steps, as a result, our new high-level schematic would look like the following:



Execution flow

The following are the key components in the redesigned process:

ProcessGuideControllerProcessGuideController  - This class orchestrates the overall execution of the business process. It

defines the factories that instantiate the step and the navigation agent, which subsequently constitute the

process execution, as well as the clean-up logic for cancellation or exiting the process.

ProcessGuideStepProcessGuideStep - This class represents one single step in the business process. This class contains a

definition of the factories that instantiate a page builder, actions, and data processors and is responsible

for invoking them in the correct sequence.

ProcessGuideNavigationAgentProcessGuideNavigationAgent - This class is responsible for navigation between the steps. When a

step is completed, the navigation agent is responsible for defining the next step and passes any

parameters that the previous step may need to communicate to the next one.

ProcessGuidePageBuilderProcessGuidePageBuilder  - This class is responsible for instantiating the user interface.

ProcessGuideActionProcessGuideAction - This class represents an action, shown as a button to the user.

ProcessGuideDataProcessorProcessGuideDataProcessor  - This class is responsible for processing the user entered data in a field.

The starting point of the execution flow remains unchanged. So, the request still arrives through the same

endpoints, followed by deserializing the XML into the container. This container is then passed to

getNextFormState()getNextFormState() .

There are three important classes to note:

ProcessGuideSessionStateProcessGuideSessionState – This contains the session state information – mode, pass, controller, and

step being executed, and so on.



ProcessGuidePageProcessGuidePage – This contains a strongly-typed representation of the user interface metadata.

ProcessGuideRequestProcessGuideRequest – This contains the above two as members and is a strongly-typed

representation of the request received from the mobile device.

These classes are created using the container information (both state and user entered control data). This

provides a type-safe way to access and manipulate the values. Compared to repeated access of the container

during the process, this provides benefit both in terms of readability and performance.

The session state information is used to instantiate the correct ProcessGuideControllerProcessGuideController  class. Once

instantiated, the createResponse()createResponse()  method in the ProcessGuideControllerProcessGuideController  class is invoked. This method is

the entry point to the process guide logic, and after execution, comes back with the response (represented in the

ProcessGuideResponseProcessGuideResponse class). The response is then converted back to the container and handed back to the

legacy logic, which then serializes it to the XML and sends the response back to the mobile device.

Next, the controller needs to find the next step to execute. If this is the start of a new process, the controller will

call initialStep()initialStep()  to get the first step in the process. After that, it would call execute()execute()  method in the

ProcessGuideStepProcessGuideStep. This method would then instantiate a ProcessGuidePageBuilderProcessGuidePageBuilder  class and call

buildPage()buildPage() , which would return with a ProcessGuidePageProcessGuidePage object, which is a virtual representation of the

user interface to be presented to the user. The step would then send the result back to the controller, which

would then save the current session state and then return the result back to getNextFormState()getNextFormState()  in the form

of the ProcessGuideResponseProcessGuideResponse class. Thereafter, the response is converted back to the container, and

subsequently serializes to XML and sends back the response to the mobile device.

The following sequence diagram explains this control flow. Note that this is the most common control flow,

simplified for explaining the design.

When the user takes an action on the mobile device by clicking a button (or scanning a value – which typically

triggers the default action) – the request arrives at the createResponse()createResponse()  method in the

ProcessGuideControllerProcessGuideController  class through the same route. This time, however, the controller knows from the

session state information which step the user is in. Accordingly, it instantiates the appropriate

ProcessGuideStepProcessGuideStep class and invokes the execute method. The ProcessGuideStepProcessGuideStep, in turn, reads the action

name invoked by the user and then instantiates the appropriate ProcessGuideActionProcessGuideAction class and calls

execute()execute() .

The ProcessGuideActionProcessGuideAction class is responsible for executing the specific action, however there are two notable

exceptions.

The first one is the ProcessGuideOKActionProcessGuideOKAction class. This action implies that the user wants to confirm and move

forward in the process. In accordance to that – this method actually does a callback to the ProcessGuideStep

class, which means that the step invokes processData()processData()  in ProcessGuideDataProcessorProcessGuideDataProcessor . This processes the
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data that the user has entered, and then updates the state of the step and sends the result back to the controller.

Depending on the outcome of the processor, the step invokes the page builder to build the appropriate user

interface or sets the status of the step as completed. This is reflected in the top half of the sequence diagram

below.

The other exception is the cancellation action, implemented in the ProcessGuideCancelResetProcessActionProcessGuideCancelResetProcessAction

and ProcessGuideCancelExitProcessActionProcessGuideCancelExitProcessAction classes. These actions represent an intent to cancel the process

and go back to either the start of the process or exit the process altogether. Similar to the OKOK action, these

actions also perform a callback to the step, which signals the intent to the ProcessGuideControllerProcessGuideController . The

controller then performs the necessary cleanup of state variables and either moves control to the initial step in

the process or terminates the process altogether.

After the step is completed, if the status of the step is set to CompletedCompleted, then the controller instantiates the

ProcessGuideNavigationAgentProcessGuideNavigationAgent, which returns the name of the next step. The controller then instantiates this

step and invokes the execute()execute()  method – and the cycle continues. Most commonly, the new step invokes the

corresponding ProcessGuidePageBuilderProcessGuidePageBuilder  to build the user interface for the next screen to be presented to the

user, which is then sent back. This flow is depicted in the lower half of the sequence diagram below.

The best way to explain the control flow is by using an example that exists in the application – the Production

Start process.

Let’s start by understanding the process flow. In the first step, the user is prompted for production order ID.



Creating the controller

[WHSWorkExecuteMode(WHSWorkExecuteMode::StartProdOrder)]
public class ProdProcessGuideProductionStartController extends ProcessGuideController

NOTENOTE

When the user enters the production order ID, the order number is validated. Some of the validations that are

run are based on whether the order is in the same warehouse as the user is signed in to, and the status of the

order. If the validation fails, the user is shown an error message. If the validation succeeds, then the user is

shown details of the production order and item.

The user can either cancel to go back to the start of the process or click OKOK to confirm. In the latter case, the

production order is set to Star tedStar ted status, the corresponding journals are posted, the control moves back to the

first step, and the “Work Completed” message is shown to the user.

The first step in building the business process is creating the controller class, extending from the

ProcessGuideControllerProcessGuideController  abstract class which implements the default behaviors of a controller. The new class

name is ProdProcessGuideProductionStar tControllerProdProcessGuideProductionStar tController  and decorated with the WHSWorkExecuteModeWHSWorkExecuteMode

value of Star tProdOrderStar tProdOrder . The same SysExtensionSysExtension based instantiation that was used in the

WHSWorkExecuteDisplayWHSWorkExecuteDisplay  classes is used, which helps instantiate the controller when the user executes a

menu item for this mode.

The naming pattern of the class is <FunctionalArea>ProcessGuide<Businessprocessname>Controller<FunctionalArea>ProcessGuide<Businessprocessname>Controller . This is the

pattern that is used for the controller classes and to extend to other classes.
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Building the user interface for the first stepBuilding the user interface for the first step

Next, to define the first step you create the ProdProcessGuidePromptProductionIdStepProdProcessGuidePromptProductionIdStep class, extending

from ProcessGuideStepProcessGuideStep.

The task of instantiating the class is delegated to a step factory, which is invoked by the

ProcessGuideControllerProcessGuideController  base class. The default implementation of the factory instantiates the step based on

name. Therefore, to instantiate ProdProcessGuidePromptProductionIdStepProdProcessGuidePromptProductionIdStep as the first step in the controller,

you must do two things:

[ProcessGuideStepName(classStr(ProdProcessGuidePromptProductionIdStep))] public class 
ProdProcessGuidePromptProductionIdStep extends ProcessGuideStep

protected final ProcessGuideStepName initialStepName()
{
    return classStr(ProdProcessGuidePromptProductionIdStep);
}

Decorate the ProdProcessGuidePromptProductionIdStepProdProcessGuidePromptProductionIdStep class with a ProcessGuideStepNameProcessGuideStepName

attribute.

In the controller class, implement the abstract method initialStepName()initialStepName()  to return the step name.

The value in the ProcessGuideStepNameProcessGuideStepName attribute does not need to exactly match the class name as shown above.

However, implementing this allows for uniformity and type-safety around cross-references when using the class. Using

this naming convention is recommended.

The ProcessGuideStepNameProcessGuideStepName based instantiation of the step is implemented in the

ProcessGuideStepDefaultFactor yProcessGuideStepDefaultFactor y  class. In the rare case that you want a different strategy for instantiating the step,

you need to do the following:

Create a new factory class inheriting from ProcessGuidStepAbstractFactor yProcessGuidStepAbstractFactor y .

Optionally, create a new parameter class implementing the ProcessGuideIStepCreationParametersProcessGuideIStepCreationParameters  interface,

containing the parameters the factory would need.

In your controller class, override the stepFactor y()stepFactor y() and stepCreationParameters()stepCreationParameters() methods to return the above

factory and parameters.

The next step is to implement the functionality of the ProdProcessGuidePromptProductionIdStepProdProcessGuidePromptProductionIdStep class. You

need to implement the logic for building the user interface, processing the user-entered data, and determining

when the step is complete.

The user interface is built using a class inheriting from the ProcessGuidePageBuilderProcessGuidePageBuilder  abstract class. For this

step, name the class to represent what it does – ProdProcessGuidePromptProductionIdPageBuilderProdProcessGuidePromptProductionIdPageBuilder .

The instantiation mechanism of the class is similar to how the step was instantiated from the controller.

[ProcessGuidePageBuilderName(classStr(ProdProcessGuidePromptProductionIdPageBuilder))] public class 
ProdProcessGuidePromptProductionIdPageBuilder extends ProcessGuidePageBuilder

Decorate the ProdProcessGuidePromptProductionIdPageBuilderProdProcessGuidePromptProductionIdPageBuilder  class with a

ProcessGuidePageBuilderNameProcessGuidePageBuilderName attribute.



TIPTIP

TIPTIP

protected final ProcessGuidePageBuilderName pageBuilderName()
{
    return classStr(ProdProcessGuidePromptProductionIdPageBuilder);
}

In the ProdProcessGuidePromptProductionIdStepProdProcessGuidePromptProductionIdStep class, implement the abstract method

pageBuilderName()pageBuilderName()  to return this name.

Similar to the step factory, there is also an abstract factory pattern implemented for the page builder factory. So, in the

rare case that you want a different strategy for instantiating the page builder, you can do the following:

Create a new factory class inheriting from ProcessGuidePageBuilderAbstractFactor yProcessGuidePageBuilderAbstractFactor y .

Optionally, create a new parameter class implementing the ProcessGuideIPageBuilderCreationParametersProcessGuideIPageBuilderCreationParameters

interface, containing the parameters the factory would need.

In your step class, override the pageBuilderFactor y()pageBuilderFactor y() and pageBuilderCreationParameters()pageBuilderCreationParameters() methods to return

the above factory and parameters.

To implement the user interface you need a page with one text box to enter the production order ID, plus an OKOK

button and a CancelCancel  button. The CancelCancel  button should exit the process.

To implement this, you need to override two methods in the

ProdProcessGuidePromptProductionIdPageBuilderProdProcessGuidePromptProductionIdPageBuilder  class:

protected final void addDataControls(ProcessGuidePage _page)
{
    _page.addTextBox(ProcessGuideDataTypeNames::ProdId, "@SYS4398", extendedTypeNum(ProdId));
}

protected final void addActionControls(ProcessGuidePage _page)
{
    #ProcessGuideActionNames
    _page.addButton(step.createAction(#ActionOK), true);
    _page.addButton(step.createAction(#ActionCancelExitProcess));
}

Use the addDataControls()addDataControls()  method to add the text box.

Use the addActionControls()addActionControls()  method to add the OKOK and CancelCancel  buttons.

This adds the data controls, followed by the buttons. However, if you want to build a screen with interspersed

data controls and buttons, you can override the addControls()addControls()  method instead for flexibility.

An additional scenario to consider is how to rebuild the page in case of validation failures, for example if the

user enters an incorrect production order ID. The ProcessGuidePageBuilderProcessGuidePageBuilder  base class implements the default

behavior, which rebuilds the user interface, clears out the scanned value, and adds the error control with the

error message. Because this is the default behavior that you want to use, you do not need to add any code for

handling errors.

If you want to implement custom UI behavior for error situations, you can override one or more of the methods

rebuildFromRequestPage()rebuildFromRequestPage(), isErrorState()isErrorState() , and reuseRequestPageOnError()reuseRequestPageOnError() .



Processing the user-entered data in the first stepProcessing the user-entered data in the first step

Determine if the first step is completeDetermine if the first step is complete

protected final boolean isComplete()
{
    WhsrfPassthrough pass = controller.parmSessionState().parmPass();
    ProdId prodId = pass.lookup(ProcessGuideDataTypeNames::ProdId);
        return (prodId != '');
}

Step two: View order details and confirmStep two: View order details and confirm

[ProcessGuideStepName(classStr(ProdProcessGuideConfirmProductionOrderStep))]
public class ProdProcessGuideConfirmProductionOrderStep extends ProcessGuideStep
{
    protected final ProcessGuidePageBuilderName pageBuilderName()
    {
        return classStr(ProdProcessGuideConfirmProductionOrderPageBuilder);
     }
}

The processing of the data is done in the ProcessGuideDataProcessorDefaultProcessGuideDataProcessorDefault class, which in turn invokes

the legacy WhsRfControlDataWhsRfControlData class. No changes are needed to this default behavior, and WhsRfControlDataWhsRfControlData

already has logic for validating the ProdIdProdId field, so you do not need to write any logic for handling this. In case

of required extensions for the validation logic, consider using the WhsControlWhsControl  based extension mechanism.

When the validation is successful, it is time to mark the step as completed. This is done in the base class,

however, you need to implement the condition to determine the step completion. The following overridden

method does that.

In the second step in the process, the user is shown a screen with details about the order. The user can either

click the OKOK button to confirm the start of the production order, or click CancelCancel  to go back to the start of the

process. For this example, name the step ProdProcessGuideConfirmProductionOrderStepProdProcessGuideConfirmProductionOrderStep and the page

builder class ProdProcessGuideConfirmProductionOrderPageBuilderProdProcessGuideConfirmProductionOrderPageBuilder .

The ProdProcessGuideConfirmProductionOrderStep class looks like the following.

Because the user does not enter any values here, you do not need to override the isComplete()isComplete()  method. The

step is complete when the user clicks OKOK.

The page builder class overrides the addDataControls()addDataControls()  method to add three labels. The first label shows the

production order ID, the second contains item information (such as item ID, dimensions, or description) and the

third contains the quantity and unit of measure.

The addActionControls()addActionControls()  is then overridden to add 2 buttons – the OKOK button, and the CancelCancel  button to

cancel the process and go back to the start of the process.



/// <summary>
/// The <c>ProdProcessGuideConfirmProductionOrderPageBuilder</c> builds a page that allows the user to see 
details of a production order
/// and then confirm.
/// </summary>
[ProcessGuidePageBuilderName(classStr(ProdProcessGuideConfirmProductionOrderPageBuilder))]
public class ProdProcessGuideConfirmProductionOrderPageBuilder extends ProcessGuidePageBuilder
{
    protected void addDataControls(ProcessGuidePage _page)
    {
        WhsrfPassthrough pass = controller.parmSessionState().parmPass();
        ProdTable prodTable = ProdTable::find(pass.lookup(ProcessGuideDataTypeNames::ProdId));
        UnitOfMeasureSymbol inventUOM = InventTableModule::find(prodTable.ItemId, 
ModuleInventPurchSales::Invent).UnitId;
        
        _page.addLabel(ProcessGuideDataTypeNames::ProdIdLabelName, strFmt("@WAX1684", prodTable.ProdId), 
extendedTypeNum(ProdId));
        _page.addLabel(ProcessGuideDataTypeNames::ItemInfo, 
this.generateItemInfoForProdId(pass.lookup(ProcessGuideDataTypeNames::ProdId)), 
extendedTypeNum(WHSRFUndefinedDataType));
        _page.addLabel(ProcessGuideDataTypeNames::QtyLabelName, strFmt("@WAX1685", 
WHSWorkExecuteDisplay::num2StrDisplay(ProdUpdStartUp::proposalStartUpQty(prodTable.ProdId)), inventUOM), 
extendedTypeNum(WHSRFQuantityAndUOM));

        if (PdsGlobal::pdsIsCWItem(prodTable.ItemId))
        {
            _page.addLabel(ProcessGuideDataTypeNames::InventQtyLabelName, strFmt("@WAX1685", 
WHSWorkExecuteDisplay::num2StrDisplay(ProdUpdStartUp::pdsCWProposalStartupQty(prodTable.ProdId)), 
PdsCatchWeightItem::pdsCWUnitId(prodTable.ItemId)), extendedTypeNum(WHSRFQuantityAndUOM));
        }
    }

    protected void addActionControls(ProcessGuidePage _page)
    {
        #ProcessGuideActionNames
        _page.addButton(step.createAction(#ActionOK), true);
        _page.addButton(step.createAction(#ActionCancelResetProcess));
    }

NOTENOTE

Step 3: Start the production orderStep 3: Start the production order

You can find the same source code for the X++ methods in this topic by using the Application Explorer. Filter on the class

name, and then right-click the class name and select View codeView code.

The third step is where the business logic of starting the production order is executed. This step is somewhat

different from the previous steps, in that, this step does not have a user interface. This step gets executed silently

when the user clicks OKOK in the previous step.

The ProcessGuideStepWithoutPromptProcessGuideStepWithoutPrompt abstract class implements the default behavior for such steps. The

current step, therefore, should extend the ProcessGuideStepWithoutPromptProcessGuideStepWithoutPrompt class and override the

doExecute()doExecute()  method.

The following code example shows the class and the doExecute()doExecute()  method implementation. The method simply

retrieves the order ID and user ID from the session state and invokes the method to start this production order.



/// <summary>
/// The <c>ProdProcessGuideStartProductionOrderStep</c> represents a step that starts a production order.
/// </summary>
[ProcessGuideStepName(classStr(ProdProcessGuideStartProductionOrderStep))]
public class ProdProcessGuideStartProductionOrderStep extends ProcessGuideStepWithoutPrompt
{
    protected final void doExecute()
    {
        WhsrfPassthrough pass = controller.parmSessionState().parmPass();
        WHSUserId userId = pass.lookup(ProcessGuideDataTypeNames::UserId);
        ProdTable prodTable = ProdTable::find(pass.lookup(ProcessGuideDataTypeNames::ProdId));
        WhsWorkExecute workExecute = WhsWorkExecute::construct();
        workExecute.prodStartUp(prodTable.ProdId, ProdUpdStartUp::proposalStartUpQty(prodTable.ProdId), 
userId);

        this.addProcessCompletionMessage();

        super();
    }

}

NOTENOTE

Building the navigation through the stepsBuilding the navigation through the steps

    protected ProcessGuideNavigationRoute initializeNavigationRoute()
    {
        ProcessGuideNavigationRoute navigationRoute = new ProcessGuideNavigationRoute();
        navigationRoute.addFollowingStep(classStr(ProdProcessGuidePromptProductionIdStep), 
classStr(ProdProcessGuideConfirmProductionOrderStep));
        navigationRoute.addFollowingStep(classStr(ProdProcessGuideConfirmProductionOrderStep), 
classStr(ProdProcessGuideStartProductionOrderStep));
        navigationRoute.addFollowingStep(classStr(ProdProcessGuideStartProductionOrderStep), 
classStr(ProdProcessGuidePromptProductionIdStep));

        return navigationRoute;
    }

In case of an exception, the framework exception handling logic ensures that the process is rolled back to the

previous step.

The invoke to addProcessCompletionMessage()addProcessCompletionMessage() adds the “Work completed” message to the navigation parameters.

The next step (assuming it has a user interface) will display this message. The base classes handle this logic, and no specific

code needs to be added to the process classes to achieve this behavior.

The ProcessGuideControllerProcessGuideController  base class instantiates the ProcessGuideNavigationAgentDefaultProcessGuideNavigationAgentDefault class,

which relies on a pre-defined navigation route, which is a simple map of source and destination steps. For the

production start scenario, because there is no conditional branching, this implementation would suffice.

Therefore, you only need to override the initializeNavigationRoute()initializeNavigationRoute()  method to define the navigation route.

There are processes where there will be conditional branching (based on user actions, or any other conditions).

Such processes need to do the following:

Implement specific navigation agents inherited from the ProcessGuideNavigationAgentProcessGuideNavigationAgent class.

Implement the specific navigation agent factory inherited from the

ProcessGuideNavigationAgentAbstractFactor yProcessGuideNavigationAgentAbstractFactor y  class, containing logic to instantiate the correct

navigation agent based on current step, session state, user action, or other logic.



Action classesAction classes

[ProcessGuideActionName(#ActionOK)]
public class ProcessGuideOKAction extends ProcessGuideAction
{
    public final str label()
    {
        return "@SYS5473";
     }
     protected final void doExecute()
     {
        step.executeOKAction();
      }
}

_page.addButton(step.createAction(#ActionOK), true);

SummarySummary

Optionally, override navigationAgentCreationParameters()navigationAgentCreationParameters()  in the controller class to pass suitable

parameters.

Override navigationAgentFactor y()navigationAgentFactor y()  in the controller to instantiate the navigation agent factory created

above.

Action classes represent user actions, so this example uses the OKOK action to show how the actions are created.

The class must implement 2 abstract methods:

label()label() , which returns the label to be displayed in a button control tied to this action.

doExecute()doExecute() , which performs the action. As mentioned earlier, the OKOK button simply performs a callback

to the step. However, other actions might have more complex logic here.

The actions are instantiated using SysExtensionSysExtension framework based on the ProcessGuideActionNameProcessGuideActionName

attribute. Similar to the instantiation of page builders, the step class implements the default action factory, and it

is possible to override that. The page builder adds a button control like this.

In doing so, it asks the step to create an action class for the passed name and ties that action to the button.

To summarize everything that's been explained in this topic, here's a comprehensive summary of the code

needed for the process:

1. ProdProcessGuideProductionStar tControllerProdProcessGuideProductionStar tController

a. Override initialStepName()initialStepName()  to provide the name of the first step.

b. Override initializeNavigationRoute()initializeNavigationRoute()  to construct the navigation map.



/// <summary>
/// The <c>ProdProcessGuideProductionStartController</c> class is the controller class for the 
production order start process guide.
/// </summary>
[WHSWorkExecuteMode(WHSWorkExecuteMode::StartProdOrder)]
public class ProdProcessGuideProductionStartController extends ProcessGuideController
{
    protected ProcessGuideStepName initialStepName()
    {
        return classStr(ProdProcessGuidePromptProductionIdStep);
    }

    protected ProcessGuideNavigationRoute initializeNavigationRoute()
    {
        ProcessGuideNavigationRoute navigationRoute = new ProcessGuideNavigationRoute();
        navigationRoute.addFollowingStep(classStr(ProdProcessGuidePromptProductionIdStep), 
classStr(ProdProcessGuideConfirmProductionOrderStep));
        navigationRoute.addFollowingStep(classStr(ProdProcessGuideConfirmProductionOrderStep), 
classStr(ProdProcessGuideStartProductionOrderStep));
        navigationRoute.addFollowingStep(classStr(ProdProcessGuideStartProductionOrderStep), 
classStr(ProdProcessGuidePromptProductionIdStep));

        return navigationRoute;
    }

}

2. ProdProcessGuidePromptProductionIdStepProdProcessGuidePromptProductionIdStep

/// <summary>
/// The <c>ProdProcessGuidePromptProductionIdStep</c> represents a step that 
/// that prompts the user for a production order id.
/// </summary>
[ProcessGuideStepName(classStr(ProdProcessGuidePromptProductionIdStep))]
public class ProdProcessGuidePromptProductionIdStep extends ProcessGuideStep
{
    protected boolean isComplete()
    {
        WhsrfPassthrough pass = controller.parmSessionState().parmPass();
        ProdId prodId = pass.lookup(ProcessGuideDataTypeNames::ProdId);

        return (prodId != '');
    }

    protected ProcessGuidePageBuilderName pageBuilderName()
    {
        return classStr(ProdProcessGuidePromptProductionIdPageBuilder);
    }

}

a. Override isComplete()isComplete()  to specify when the step is considered complete.

b. Override pageBuilderName()pageBuilderName()  to specify the page builder to be used.

3. ProdProcessGuidePromptProductionIdPageBuilderProdProcessGuidePromptProductionIdPageBuilder

a. Override addDataControls()addDataControls()  to add the Prod IDProd ID textbox.

b. Override addActionControls()addActionControls()  to add the OKOK and CancelCancel  buttons.



/// <summary>
/// The <c>ProdProcessGuidePromptProductionIdPageBuilder</c> class builds a page 
/// that prompts the user for a production order id.
/// </summary>
[ProcessGuidePageBuilderName(classStr(ProdProcessGuidePromptProductionIdPageBuilder))]
public class ProdProcessGuidePromptProductionIdPageBuilder extends ProcessGuidePageBuilder
{
    protected void addDataControls(ProcessGuidePage _page)
    {
        _page.addTextBox(ProcessGuideDataTypeNames::ProdId, "@SYS4398", 
extendedTypeNum(ProdId));
    }

    protected void addActionControls(ProcessGuidePage _page)
    {
        #ProcessGuideActionNames
        _page.addButton(step.createAction(#ActionOK), true);
        _page.addButton(step.createAction(#ActionCancelExitProcess));
    }

}

4. ProdProcessGuideConfirmProductionOrderStepProdProcessGuideConfirmProductionOrderStep

/// <summary>
/// The <c>ProdProcessGuideConfirmProductionOrderStep</c> class represents the step for 
viewing production order
/// details and confirming the same.
/// </summary>
[ProcessGuideStepName(classStr(ProdProcessGuideConfirmProductionOrderStep))]
public class ProdProcessGuideConfirmProductionOrderStep extends ProcessGuideStep
{    
    protected ProcessGuidePageBuilderName pageBuilderName()
    {
        return classStr(ProdProcessGuideConfirmProductionOrderPageBuilder);
    }

}

a. Override pageBuilderName()pageBuilderName()  to specify the page builder to be used.

5. ProdProcessGuideConfirmProductionOrderPageBuilderProdProcessGuideConfirmProductionOrderPageBuilder

a. Override addDataControls()addDataControls()  to add the order, item, and quantity information labels.

b. Override addActionControls()addActionControls()  to add the OKOK and CancelCancel  buttons.



/// <summary>
/// The <c>ProdProcessGuideConfirmProductionOrderPageBuilder</c> builds a page that allows the 
user to see details of a production order
/// and then confirm.
/// </summary>
[ProcessGuidePageBuilderName(classStr(ProdProcessGuideConfirmProductionOrderPageBuilder))]
public class ProdProcessGuideConfirmProductionOrderPageBuilder extends ProcessGuidePageBuilder
{
    protected void addDataControls(ProcessGuidePage _page)
    {
        WhsrfPassthrough pass = controller.parmSessionState().parmPass();
        ProdTable prodTable = ProdTable::find(pass.lookup(ProcessGuideDataTypeNames::ProdId));
        UnitOfMeasureSymbol inventUOM = InventTableModule::find(prodTable.ItemId, 
ModuleInventPurchSales::Invent).UnitId;

        _page.addLabel(ProcessGuideDataTypeNames::ProdIdLabelName, strFmt("@WAX1684", 
prodTable.ProdId), extendedTypeNum(ProdId));
        _page.addLabel(ProcessGuideDataTypeNames::ItemInfo, 
this.generateItemInfoForProdId(pass.lookup(ProcessGuideDataTypeNames::ProdId)), 
extendedTypeNum(WHSRFUndefinedDataType));
        _page.addLabel(ProcessGuideDataTypeNames::QtyLabelName, strFmt("@WAX1685", 
WHSWorkExecuteDisplay::num2StrDisplay(ProdUpdStartUp::proposalStartUpQty(prodTable.ProdId)), 
inventUOM), extendedTypeNum(WHSRFQuantityAndUOM));

        if (PdsGlobal::pdsIsCWItem(prodTable.ItemId))
        {
            _page.addLabel(ProcessGuideDataTypeNames::InventQtyLabelName, strFmt("@WAX1685", 
WHSWorkExecuteDisplay::num2StrDisplay(ProdUpdStartUp::pdsCWProposalStartupQty(prodTable.ProdId
)), PdsCatchWeightItem::pdsCWUnitId(prodTable.ItemId)), extendedTypeNum(WHSRFQuantityAndUOM));
        }
    }

    protected void addActionControls(ProcessGuidePage _page)
    {
        #ProcessGuideActionNames
        _page.addButton(step.createAction(#ActionOK), true);
        _page.addButton(step.createAction(#ActionCancelResetProcess));
    }

NOTENOTE
The generateItemInfoForProdId()generateItemInfoForProdId() method, which is used for generating the item information labels, is

excluded from this topic. This method queries a few tables to get item ID, description, and dimensions. If

you want a better understanding of generateItemInfoForProdId()generateItemInfoForProdId() , look at the source code.

6. ProdProcessGuideStar tProductionOrderStepProdProcessGuideStar tProductionOrderStep

a. Override doExecute()doExecute()  to perform the production start process and add the process completion

message.



NOTENOTE

Extending a business processExtending a business process

Add a step in a flow (using ProcessGuideNavigationAgentDefault)Add a step in a flow (using ProcessGuideNavigationAgentDefault)

Add a step in a flow (using custom navigation agent)Add a step in a flow (using custom navigation agent)

/// <summary>
/// The <c>ProdProcessGuideStartProductionOrderStep</c> represents a step that starts a 
production order.
/// </summary>
[ProcessGuideStepName(classStr(ProdProcessGuideStartProductionOrderStep))]
public class ProdProcessGuideStartProductionOrderStep extends ProcessGuideStepWithoutPrompt
{
    protected final void doExecute()
    {
        WhsrfPassthrough pass = controller.parmSessionState().parmPass();
        WHSUserId userId = pass.lookup(ProcessGuideDataTypeNames::UserId);
        ProdTable prodTable = ProdTable::find(pass.lookup(ProcessGuideDataTypeNames::ProdId));
        WhsWorkExecute workExecute = WhsWorkExecute::construct();
        workExecute.prodStartUp(prodTable.ProdId, 
ProdUpdStartUp::proposalStartUpQty(prodTable.ProdId), userId);

        this.addProcessCompletionMessage();

        super();
    }

}

Note that a lot of the common patterns (regeneration of UI on error, setting process completion message, OKOK and

CancelCancel behavior) have been moved to the framework – thus saving the application developer from writing boilerplate

code that is both error prone, and has a risk of inconsistent behavior across processes. Where the scenario needs to

deviate from the common path, though, the application developer is provided the option of overriding suitable methods –

but then that is an intentional deviation that is both explicit and trackable.

So far, this topic has highlighted how to build a new process using the ProcessGuideProcessGuide framework. In this final

section, you will find some examples of how this business process can be extended.

Where to extend:

Child of ProcessGuideControllerProcessGuideController  class for the process.

How to extend:

Extend the initializeNavigationRoute()initializeNavigationRoute()  method in the controller class, and invoke addFollowingStep()addFollowingStep()  in

the ProcessGuideNavigationRouteProcessGuideNavigationRoute class.

Where to extend:

Child of ProdProcessGuideNavigationAgentFactor y/ProdProcessGuideNavigationAgentProdProcessGuideNavigationAgentFactor y/ProdProcessGuideNavigationAgent.

How to extend:

Create a new child class of ProcessGuideNavigationAgentProcessGuideNavigationAgent that returns the desired step name.

Create a new class deriving from ProcessGuideNavigationAgentFactor yProcessGuideNavigationAgentFactor y  that conditionally returns

the navigation agent created above.

Extend the navigationAgentFactor y()navigationAgentFactor y()  method in the controller class to return the factory created

above.



Add a new control in the UI of an existing stepAdd a new control in the UI of an existing step

Complete overhaul of the user interface in an existing stepComplete overhaul of the user interface in an existing step

Alter logic when a step is considered completeAlter logic when a step is considered complete

NOTENOTE

Where to extend:

Child of ProdProcessGuidePageBuilderProdProcessGuidePageBuilder  for the step.

How to extend:

Extend the addDataControls()addDataControls()  method and add the additional control.

Where to extend:

Child of ProdProcessGuideStepProdProcessGuideStep.

How to extend:

Create a new child class of ProdProcessGuidePageBuilderProdProcessGuidePageBuilder  class, and implement the desired user

interface.

Extend the pageBuildeName()pageBuildeName()  method in the step class to return the

ProcessGuidePageBuilderNameAttr ibuteProcessGuidePageBuilderNameAttr ibute for the class created above.

Where to extend:

Child of ProdProcessGuideStepProdProcessGuideStep.

How to extend:

Extend the isComplete()isComplete()  method to build the additional logic.
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NOTENOTE

Trust anchor for certification path not found

ScopeScope

Possible root causePossible root cause

ResolutionResolution

This topic describes how to fix common issues that you might encounter while connecting the Dynamics 365 for

Finance and Operations - Warehousing application to Dynamics 365 Supply Chain Management.

If you encounter issues that aren't listed on this page, please contact Microsoft Support and let us know so we can help

you resolve the errors.

This section explains what to do if the warehousing app shows a Trust anchor for cer tification path notTrust anchor for cer tification path not

foundfound error when trying to connect to Supply Chain Management.

This issue can affect devices with the following properties:

OS versionOS version: Android 4.4.x (such as Zebra TC55). This is not an issue on recent Android versions.

Supply Chain Management locationSupply Chain Management location: Cloud

Connection modeConnection mode: Client secret or certificate

Microsoft may have updated the server SSL certificates used by Supply Chain Management. As a result, the root

certificate and/or one of the intermediate certificates may have changed, so the new certificate isn't on the list of

trusted system certificates for the mobile device. Newer versions of Android automatically update the lists of

trusted certificates, but Android 4.4.x doesn't.

Do one of the following to resolve this issue:

Use the workaround described in the next section to update each relevant device.

It might be possible to contact Zebra or Google to get an update of the system trusted certifying authority

(CA) certificates. However, we have not confirmed this.

If possible, consider replacing older devices with devices that are running a more recent version of Android

(where trusted CA certificates are updated automatically).

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/troubleshoot-warehouse-app-connection.md


WorkaroundWorkaround
Step 1: Export the new root certificate from Supply Chain ManagementStep 1: Export the new root certificate from Supply Chain Management

Step 2: Install the downloaded certificate onto the affected devicesStep 2: Install the downloaded certificate onto the affected devices

NOTENOTE

Manually download the new root certificate using your internet browser by doing the following:

1. Sign in to Dynamics Supply Chain Management and open the front page.

2. In the address bar of your browser, select the lock icon to open the Location is secureLocation is secure dialog box.

3. In the dialog box, select Cer tificate (valid)Cer tificate (valid)  to open the Cer tificateCer tificate window for that certificate.

4. Open the Cer tification pathCer tification path tab of the Cer tificateCer tificate window.

5. Select the top certificate shown in the hierarchy (this is the root certificate).

6. Open the DetailsDetails  tab of the Cer tificateCer tificate window.

7. Select the Copy to fileCopy to file button at the bottom of the DetailsDetails  tab.

8. The Cer tificate expor t wizardCer tificate expor t wizard opens. Select NextNext to continue.

9. The Expor t file formatExpor t file format page opens. Select DER encoded binar y X .509 (.CER)DER encoded binar y X .509 (.CER) . Then select NextNext to

continue.

10. The Files to expor tFiles to expor t page opens, specify a file name and location. Then select NextNext to continue.

11. The Completing the cer tificate expor t wizardCompleting the cer tificate expor t wizard page opens, showing the result of your export. Select

FinishFinish .

Install the downloaded certificate by doing the following:

1. Transfer the certificate you downloaded in the previous step to the device you want to update. For example,

you might use an SD card or network connection to make the file available to your device.

2. Open the security settings for your device and choose the menu option to install a certificate from a file. (The

exact steps for this vary based on device and OS version.)

3. The new certificate should now be shown on the UserUser  tab for trusted certificates.

4. Repeat this procedure for each affected device.

Can you tell us about your documentation language preferences? Take a short survey.
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Upgrading to Supply Chain Management when AX 2012 R3 WMSII is
used

Enabling items in Supply Chain ManagementEnabling items in Supply Chain Management

NOTENOTE

Find products that were blocked because of Pallet ID

Change storage dimension group for blocked products

This topic provides an overview of the process of upgrading from Microsoft Dynamics AX 2012 R3, running the

WMSII module, to Supply Chain Management .

Supply Chain Management no longer supports the legacy WMSIIWMSII module from Microsoft Dynamics AX 2012.

Instead, you can use the Warehouse managementWarehouse management module. In the WMSII module, the Location and Pallet ID

inventory dimensions could be selected for financial inventory, however, the Pallet ID inventory dimension

cannot be used for financial inventory in Supply Chain Management .

During an upgrade, all products that are associated with a storage dimension group that uses the Pallet ID

inventory dimension are identified, marked as blocked, and not processed for upgrade.

After the upgrade, you can use a set of options in the Change storage dimension group for itemsChange storage dimension group for items form to

unblock products that were blocked during upgrade, and then process transactions for those products.

This change is required because in Supply Chain Management, item tracking is part of the warehouse

management processes. For these processes, all warehouses and their locations must be associated with a

location profile. If you want to use warehouse management processes, the following must be configured:

Existing warehouses must be enabled to use warehouse management processes

Existing released products must be associated with a storage dimension group that uses warehouse

management processes

If the source storage dimension groups use the Pallet ID inventory dimension, the locations of existing on-hand

inventory that used the Pallet ID inventory dimension must be associated with a location profile in which the

Use license plate trackingUse license plate tracking parameter is selected. If the existing warehouses should not be enabled to use

warehouse management processes, you can change the storage dimension groups of the existing on-hand

inventory to groups that handle only the Site, Warehouse, and Location inventory dimensions.

You can change the storage dimension group for items even if open inventory transactions exist.

To view the list of released products that were blocked during upgrade and can't be processed, click Inventor yInventor y

managementmanagement > SetupSetup > Inventor yInventor y  > Items blocked for inventor y updatesItems blocked for inventor y updates .

To be used as part of a warehouse management process, an item must be associated with a storage dimension

group in which the Location inventory dimension is active, and the Use warehouse management processesUse warehouse management processes

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/warehousing/upgrade-migration-warehouse-management-processes.md


Configure warehouse management processes

Enable warehouses to use warehouse management processesEnable warehouses to use warehouse management processes

Change the storage dimension group for items, so that it uses warehouse management processesChange the storage dimension group for items, so that it uses warehouse management processes

parameter is selected. When this setting is selected, the Site, Warehouse, Inventory status, Location, and License

plate inventory dimensions become active.

To unblock products that were blocked during upgrade, you must select a new storage dimension group for the

products. Note that you can change the storage dimension group even if open inventory transactions exist. To

use items that were blocked during upgrade, you have two options:

Change the storage dimension group for the item to a storage dimension group that uses only the Site,

Warehouse, and Location inventory dimensions. As a result of this change, the Pallet ID inventory dimension

is no longer used.

Change the storage dimension group for the item to a storage dimension group that uses the warehouse

management processes. As a result of this change, the License plate inventory dimension is now used.

Before you can use released products in the Warehouse managementWarehouse management module, the products must use a

storage dimension group where the Use warehouse management processesUse warehouse management processes  parameter is selected.

1. Create at least one new location profile.

2. Click Warehouse managementWarehouse management > SetupSetup > Enable warehouse management processesEnable warehouse management processes  > EnableEnable

warehouse setupwarehouse setup.

3. On the Enable warehouse setupEnable warehouse setup page, add the warehouses that should be enabled. You can complete this

step either directly on the page or by using the Microsoft Office integration.

4. Assign a location profile to all the locations. You can easily complete this step by using the Microsoft Office

integration directly from the page. You can either export and import the data, or use the data entity

processing in Data management.

5. Validate the changes. As part of the validation process, various validations of data integrity occur. As part of a

larger upgrade process, issues that occur might have to be adjusted on the source implementation. In this

case, an additional data upgrade will be required.

6. Process the changes.

1. Create a new Inventor y statusInventor y status  value, and assign it as the Default inventor y status IDDefault inventor y status ID value in the

Warehouse management parametersWarehouse management parameters  settings.

2. Create a new storage dimension group where the Use warehouse management processesUse warehouse management processes  parameter is

selected.

3. On the Reser vation hierarchyReser vation hierarchy  page, define a new reservation hierarchy according to the item’s storage

and tracking dimension groups.

4. Create one or more unit sequence groups that include at least the same units that are used for the items'

inventory units.

5. Click Warehouse managementWarehouse management > SetupSetup > Enable warehouse management processesEnable warehouse management processes  > ChangeChange

storage dimension group for itemsstorage dimension group for items .

6. On the Change storage dimension group for itemsChange storage dimension group for items page, add the item numbers, storage dimension

groups, and unit sequence groups. You can complete this step directly on the page, by using the Microsoft

Office integration, or by using the data entity process in Data management.

7. Validate the changes. As part of the validation process, various validations of data integrity occur. As part of a

larger upgrade process, issues that occur might have to be adjusted on the source implementation. In this

case, additional data upgrade will be required.

8. Process the changes. An update of all the inventory dimensions can take a while. You can monitor the

progress by using the batch jobs tasks.

file:///T:/eiye/ac1a/dynamics365/dev-itpro/data-entities/data-entities.html
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I receive the following error message:
"java.security.cert.certPathValidatorException: Trust anchor for
certification path is not found."
Issue descriptionIssue description

Issue resolutionIssue resolution

What is the approved process for moving from basic warehousing to
advanced warehousing?
Issue descriptionIssue description

Issue resolutionIssue resolution

NOTENOTE

This topic describes how to fix common issues that you might encounter while you upgrade and migrate to

advanced warehouse management.

You receive this error message in the warehouse app, because self-signed certificates aren't trusted on Android

8+ in on-premises environments.

Use an external (public) certifying authority (CA). A fix for this issue is available in version 1.9.0.0 of the

warehouse app. For more information about this issue and how to fix it, see Troubleshoot warehouse app

connection issues.

You're currently running under stock/inventory management and using basic stock functionality, and you want

to move to advanced warehousing to take advantage of mobile devices, waves, and work. However, you're

experiencing issues when you try to make this move. For example, you can't change your products so that they

use storage dimensions (site, warehouse, and location), because the products have transactions against them.

Therefore, you must learn the approved process for moving from basic warehousing to advanced warehousing.

For more information about the process for moving from basic warehousing to advanced warehousing, see the

following blog posts and documentation:

Enable warehouse management process for existing items and warehouses

Migration of Microsoft Dynamics AX WMS to new R3 warehouse and transportation functionality

WMSI/WMS2 item migration

Upgrade warehouse management from Microsoft Dynamics AX 2012 to Supply Chain Management

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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I can't use any role except administrator to access the mobile device
app emulator.
Issue descriptionIssue description

Issue resolutionIssue resolution

NOTENOTE

This topic describes how to fix common issues that you might encounter while you set up warehouses in

Microsoft Dynamics 365 Supply Chain Management.

You can't any use role except the administrator tole to access the mobile device app emulator.

The mobile device app emulator is set to work only with the administrator account. For all testing and live

process purposes, we recommend that you use the warehouse app itself.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).
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What’s new for Gantt

High-level overview of the control

Adding activities, links, and milestone markers

This topic describes how to create new forms by using the Gantt control. We highly recommend that you look at

the code in the Tutorial_Gantt form. This code demonstrates the full capabilities of the Gantt control, and shows

how to load data and work with the application programming interface (API).

In Microsoft Dynamics AX 2012, the client was a Win32 application, and extensions used Microsoft ActiveX,

WinForm, or Microsoft Windows Presentation Foundation (WPF) controls. ActiveX and ManagedHost controls

can no longer be used to add custom controls, because they are incompatible with the HTML-based platform.

Instead, a new extensible control framework lets you add controls by using HTML and JavaScript. The new Gantt

control is implemented by using this framework. Note that, unlike in earlier versions, you don't have to pay an

additional license fee to use the control in your own forms or to extend the control.

The following illustration shows the visual elements of the Gantt control.

To add the control to a new form, just right-click the top node in the form design, and then select Add newAdd new  >

GanttGantt. After you set the HeightHeight and WidthWidth properties to S izeToAvailableSizeToAvailable, there are no other properties that

must be set in the designer. Unlike many other controls, Gantt controls can't be bound to data sources. Instead,

you must add all data to the control from code.

The most basic element of a Gantt chart is the task activity. Each activity is allocated its own row in the chart.

Activities can form a hierarchy, like a tree, by referencing a parent activity. Additionally, any two activities can be

connected to each other through links (across hierarchies). To add data to the control, you build up a list that

contains the instances of the element that you want to add. You then assign the list to the control by using a

parmparm method. Note that, when you modify data, you can't just modify the content of the list. To notify the client

that data has changed, and to trigger a refresh, you must reassign the list to the control by using the parmparm

method.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/user-interface/gantt-development-guide.md
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Column headers and content

Each activity must have a unique ID across all activity types. This ID is required in order to build the hierarchy

and the links. The ID is also used to identify the activity when the server is notified after a user interaction. There

are two types of milestones: the milestone activity is a stand-alone activity that receives its own row in the chart

and can be referenced from the links, whereas the milestone markers appear on the same row as the related

activity. Both types of markers are represented by using symbols from the Dynamics Symbol font.

In the “grid” on the left side of the control, you can arrange the data into columns. The column definitions are

provided through the GanttControl.parmColumnsGanttControl.parmColumns property, which is a list of GanttControlColumnGanttControlColumn objects.

The content of the columns is given as a simple L istL ist object that contains the text strings for an activity through

the GanttControlActivity.parmColumnTextsGanttControlActivity.parmColumnTexts  property. Note that the values in the column list must be

strings. Therefore, any formatting of numbers, enumerations, dates, and so on, must occur on the server side.

The formatting of utcdatetimeutcdatetime must take into account the user's preferred time zone, because that time zone

will be used when the Gantt chart is rendered.
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Working times

Color use

Interactions

An activity can reference a calendar. A calendar is basically a list of working time intervals. A calendar is used to

visually separate working time from non-working time by giving the “cells” (intersections of a row and a time

scale interval) a different background color. Note that these working time intervals don't have to come from the

standard calendar tables. The intervals are just data that you can load from anywhere. Although calendars are a

nice feature that can give you a good overview, there are some performance issues that you must consider.

When you turn calendars on (by setting GanttControlConfiguration.parmUseCalendarsGanttControlConfiguration.parmUseCalendars  to truetrue), each

“cell” is rendered in HTML by using a DIV element. If a calendar shows lots of activities for a long period at a

very granular minor timescale, there will be many DIV elements. Depending on the browser and hardware, the

large number of DIV elements can cause performance issues for the user. In this case, you might have to turn

calendars off. In this way, you significantly reduce the number of DIV elements that must be rendered. The

control can't turn off calendars by itself to improve performance. Based on the specific scenario, you must

determine what will be best for the user.

Elements such as the activities and milestone markers have a color property. Typically, either the int value for a

specific color is calculated by using the WinAPI::RGB2intWinAPI::RGB2int method, or the user sets the value by using the color

picker (which is opened by calling ColorSelection::selectColorColorSelection::selectColor ). Instead of controlling the colors yourself, you

can specify that the colors should adhere to the current theme. When you set the

GanttControlConfiguration.parmUseThemeColorsGanttControlConfiguration.parmUseThemeColors  option to truetrue, if any color values have been set that

aren't part of the current theme, they are overridden (no colors have to be specified manually). When theme

colors are used, the parmIsActiveparmIsActive flag on an activity is used to determine whether the activity should appear in

a dark color or a light color.

Whenever the user interacts with the Gantt, an event is raised to notify the server-side code. The following

events are currently available:

onActivitySelected(str _activityId, GanttControlActivityIdCollection _allSelectedActivityIds)

onActivityDblClick(str _activityId)

onSummaryActivityExpand(str _activityId)

onSummaryActivityCollapse(str _activityId)

onActivityChanged(GanttControlActivityModification _modification,

GanttControlActivityModificationResponse _response)

All these events are one-way notifications from the client. However, the onActivityChangedonActivityChanged event is somewhat

special, because you can set a response. Typically, when a user makes a modification (for example, dragging an

activity to a new time), either other activities must also be updated or some adjustments must be made to the

activity itself (for example, the column texts must be changed). In the

GanttControlActivityModificationResponseGanttControlActivityModificationResponse response, you can provide a list of activities that must be

updated. If the change that the user makes is just accepted as is, no response must be set. However, at the very

least, the column texts of the current activity must be updated in most cases, to guarantee that the new from and

to dates appear. On an activity, the parmAllowMoveparmAllowMove flag determines whether the activity can be moved.

However, higher-level flags on GanttControlConfigurationGanttControlConfiguration determine whether any activity can be moved

(parmAllowMoveActivitiesparmAllowMoveActivities ) or resized (parmAllowResizeActivitiesparmAllowResizeActivities ), or whether the completion percentage

for the activity can be changed (parmAllowCompletionChangeparmAllowCompletionChange).
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Create a new TMS engine

This topic describes how to create a new transportation management engine in Dynamics 365 Supply Chain

Management.

Transportation management (TMS) engines define the logic that is used to generate and process transportation

rates in Transportation management. Supply Chain Management provides several different engine types that

calculate different parameters, such as rates, transit times, and the number of zones that will be crossed during

transit. This article explains how to use the Microsoft Visual Studio development environment together with

Supply Chain Management development tools to create and deploy a new TMS engine, and then how to set up

the engine in Operations. For more information about the engines, see Transportation management engines.

This section explains how to create a class library that has a TMS engine implementation, and how to reference

it from a Supply Chain Management model.

1. To deploy your new engines, you must have a model that will contain the engines. On the DynamicsDynamics

365365  > Model ManagementModel Management menu, click Create modelCreate model  to create a new model. On the first page of the

Create modelCreate model  wizard, name the model TMSEnginesTMSEngines .

2. On the next page, select Create new packageCreate new package.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/supply-chain/transportation/create-new-transportation-management-engine.md
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3. On the next page, select the ApplicationSuiteApplicationSuite model to reference. (The ApplicationPlatformApplicationPlatform model is

preselected.)

4. On the next page, click FinishFinish to confirm the creation of a new model.
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5. In a new solution, create a new Supply Chain Management project, and name it TMSThirdPar tyTMSThirdPar ty . In the

project properties, set the project's model to TMSEnginesTMSEngines .

6. Add a new C# class library to your solution, and name it ThirdPar tyTMSEnginesThirdPar tyTMSEngines .

7. In the ThirdPartyTMSEngines project, add references to Supply Chain Management–specific assemblies:

[Packages root]\ApplicationPlatform\bin\Dynamics.AX.ApplicationPlatform.dll
[Packages root]\ApplicationFoundation\bin\Dynamics.AX.ApplicationFoundation.dll
[Packages root]\ApplicationSuite\bin\Dynamics.AX.ApplicationSuite.dll

Microsoft.Dynamics.ApplicationPlatform.Environment.dll
Microsoft.Dynamics.AX.Data.Core.dll
Microsoft.Dynamics.AX.Framework.Linq.Data.AdoNet.dll
Microsoft.Dynamics.AX.Framework.Linq.Data.dll
Microsoft.Dynamics.AX.Framework.Linq.Data.Interface.dll
Microsoft.Dynamics.AX.Framework.Linq.Data.Msil.dll
Microsoft.Dynamics.AX.Server.Core.dll
Microsoft.Dynamics.AX.Xpp.AxShared.dll
Microsoft.Dynamics.AX.Xpp.Support.dll

[Packages root]\ApplicationSuite\bin\Microsoft.Dynamics.AX.Tms.dll
[Packages root]\ApplicationSuite\bin\Microsoft.Dynamics.AX.Tms.Base.dll

Application assemblies that enable X++ types to be referenced. These assemblies can be found in

the following locations. [Packages root] is the path of the location where all the deployed

assemblies are placed, such as C:\Packages.

Framework assemblies that enable access to data, LINQ, and auxiliary functions. All these

assembles can be found in [Packages root]\bin.

The core TMS assembly (which contains engines) and the TMS base assembly (which contains

helpers, constants, data transfer class definitions, and so on). These assemblies can be found in the

following locations.

8. Rename the C# class that is automatically generated in the ThirdPartyTMSEngines project to

file:///T:/eiye/ac1a/dynamics365/supply-chain/transportation/media/042.png


namespace ThirdPartyTMSEngines
{
    using Dynamics.AX.Application;
    using Microsoft.Dynamics.Ax.Tms.Base.Data;
    using Microsoft.Dynamics.Ax.Tms.Base.Utility;
    using Microsoft.Dynamics.Ax.Tms.Bll;
    using System.Xml.Linq;
    public class SampleRatingEngine : BaseRateEngine
    {
        public override RatingDto rate(TmsTransactionFacade transactionFacade, XElement shipment, 
TMSRateMasterCode rateMasterCode)
        {
           XElement re = shipment.RetrieveOrCreateRatingEntity(this.RatingDto);
           re.AddRate(TmsRateType.Rate, 100);
           return this.RatingDto;
        }
    }
}

SampleRatingEngineSampleRatingEngine.

9. Implement the engine. Because we are creating a rate engine in this example, we inherit from the base

class for rate engines. The base class implements most of the rate engine interface

(TMSFwkIRateEngineTMSFwkIRateEngine). We just have to implement the rate method. To keep this example simple, we

will make this method register a hard-coded rate of 100. You can create engines that implement any of

the engine interfaces, such as TMSFwkIAccessorialEngineTMSFwkIAccessorialEngine. All the engine interfaces are defined in X++.

10. Build the solution.

11. Add a new reference to the TMSThirdParty project. The reference should point to the

ThirdPartyTMSEngines project. When you've finished, your solution should look like this.

12. Build the solution. Verify that the new library appears in the ReferencesReferences  node in Application Explorer.
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Deploy the TMS engine as a package

Set up the TMS engine in Supply Chain Management

One way to deploy third-party TMS engines is through a deployment package. This approach is recommended

in a production environment. In a development environment, you can manually copy the assemblies, as

described in the next section, "Set up a TMS engine in Supply Chain Management." To deploy the engine as a

package, follow these steps.

1. On the Dynamics 365Dynamics 365  > DeployDeploy  menu, click Create Deployment PackageCreate Deployment Package.

2. In the Create Deployment PackageCreate Deployment Package dialog box, select the TMSEngines model, and enter the path where

you want to store your package files.

3. You can now deploy the package to the target environment. For a tutorial, see Install a deployable

package.

This section explains how to set up Supply Chain Management to use a TMS engine, and shows how the new

engine that we have created is used in rate shopping. The example in this section uses the USMF demo data

company.

1. Create a new engine as described in the "Create a new TMS engine" section.

2. Build your solution.

3. Copy the resulting assembly into the binary location of the Supply Chain Management server,
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Tips and tricks

[AOSWebRoot]bin. Note:Note: This step is relevant only in a development environment. In a production

environment, you should deploy through a deployment package. For instructions, see the previous

section, "Deploy the TMS engine as a package."

4. In Supply Chain Management, on the Rate enginesRate engines  page, create a new rating engine. The engine should

point to the engine assembly that is produced by building the engine class library and the engine class

that you implemented.

5. Create a shipping carrier that uses the Sample rate engine. Because our engine doesn't use any data, you

don’t have to assign a rate master.

6. On the Rate route workbenchRate route workbench page, click Rate shopRate shop. You should see a rate of 100.00 from

SampleCarrier, as shown in the following screen shot. In this example, we are rate shopping for a route

from warehouse 24 to customer US-004. However, but because the rate is hard-coded, you will always

see a rate of 100.00.

If you’re using development tools for Supply Chain Management, it's useful to add a new project to your

solution. If you set this project as your startup project and start a debugging session, you can debug both
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NOTENOTE

X++ and C# code in the same debugging session.

Every time that you change and recompile your ThirdPartyTMSEngines project, you must manually copy the

resulting assembly to the binary location or deploy through a deployment package. Otherwise, you might

run by using a stale assembly.

After you execute TMS-specific operations inSupply Chain Management, the Internet Information Services

(IIS) worker process might lock the ThirdPartyTMSEngines assembly so that the assembly can’t be updated.

In this case, restart the w3svc process.
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[ExtensionOf(classStr(InventSiteOnHandAggregatedViewBuilder))]
public final class InventOnHandAggregatedViewBuilder\_Extension
{
    protected Map getExtensionFields()
    {
        next getExtensionFields();
        Map extensionFields = new Map(Types::Int64, Types::Int64);
        extensionFields.insert(fieldNum(InventSiteOnHandView, Custom field 1), 
fieldNum(InventSiteOnHandAggregatedView, Custom field 1));
        extensionFields.insert(fieldNum(InventSiteOnHandView, Custom field 2), 
fieldNum(InventSiteOnHandAggregatedView, Custom field 2));
        extensionFields.insert(fieldNum(InventSiteOnHandView, Custom field 3), 
fieldNum(InventSiteOnHandAggregatedView, Custom field 3));
        extensionFields.insert(fieldNum(InventSiteOnHandView, Custom field 4), 
fieldNum(InventSiteOnHandAggregatedView, Custom field 4));
        return extensionFields;
    }
}

Microsoft Dynamics 365 Supply Chain Management provides extensibility features that let you add fields to

tables through extension. This topic provides an example that shows how to add extended fields to the 

INVENTORSITEONHANDENTITY  and INVENTWAREHOUSEONHANDENTITY  views, so that the capabilities of the inventory on-

hand data entities can work with the extensions. For more information about data entities, see Data

management overview.

Here is a list of some of the inventory on-hand data entities:

Inventory on-hand by site

Inventory on-hand by site V2

Inventory on-hand by warehouse

Inventory on-hand by warehouse v2

After you add fields to tables that are used by the inventSiteOnHandView  view, you must sync the engine so that

the extensions are correctly recognized.

1. Extend the InventSiteOnHandView  view by adding the extension field.

2. Extend the InventSiteOnHandAggregatedView  view with the extension fields.

3. Extend the InventSiteOnHandAggregatedViewBuilder  viewBuilder class by modifying the getExtensionFields()

method. In this way, you map old view fields to new view fields when viewBuilder synchronization is run.

For example, you've added the following four fields to the InventTable  table through extension:

Custom field 1

Custom field 2

Custom field 3

Custom field 4

In the case, you must modify the getExtensionFields()  method in the following way.
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NOTENOTE

After you complete these steps, you can extend the inventory on-hand by site and inventory on-hand by

warehouse data entities by adding the new fields. In this way, you ensure that the extended fields are recognized

and included during data migration that uses those data entities.
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NOTENOTE

Developer experience

Administrator experience and Lifecycle Services

Effective November 2020:

Common Data Service has been renamed to Microsoft Dataverse. For more information, see Power Automate Blog.

Some terminology in Microsoft Dataverse has been updated. For example, entity is now table and field is now column.

For more information, see Terminology updates.

This topic will be updated soon to reflect the latest terminology.

Development and administration for Finance and Operations apps includes:

Administrator experience and Lifecycle Services

Developer experience

Intelligence

Mobile apps

Data management and data entities

Office integration

The developer experience is based on modern tooling using Visual Studio and .NET components.

The development tools are decoupled from any running environment, which means that you develop against

local, XML-based files, not the online database.

Microsoft Visual Studio is the development environment. Finance and Operations customizes the Visual

Studio environment to provide you with a smooth and familiar experience.

The X++ compiler generates Common Intermediate Language (CIL) for all features. CIL is the same

intermediate language used by other .NET-based (managed) languages, such as the C# programming

language.

You can leverage the browser-based client and design patterns for forms to provide an improved end-user

experience.

The Application Lifecycle Management (ALM) system supports build automation, test automation, and

deployment of models to the cloud.

For more information, see Develop and customize home page.

Finance, Supply Chain Management, and Commerce are cloud-hosted. As an IT professional, you can use

Dynamics Lifecycle Services (LCS) to monitor and tune your environments, deploy features, and stay up to date

with recent hotfixes. Within your deployment, you can configure security, and manage when processes run. You

can also use LCS when you are called on to support business intelligence and reporting, mobile apps, Office, and

other integrations.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/fin-ops-core/dev-itpro/index.md
https://aka.ms/PAuAppBlog
https://go.microsoft.com/fwlink/?linkid=2147247
https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/dev-tools/developer-home-page
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Finance and Operations provides five distinct reporting experiences. Specialized tools are provided to meet the

complex and diverse reporting needs of various functions throughout the organization.

Operational views – Designed to address the specific needs of a given business persona.

Business documents – Static documents used to capture and exchange processed business data.

Analytical tools and visualizations – Personalized presentations of logical calculations that allow the user to

explore their data.

Electronic reporting – Tool used to configure formats for electronic documents.

Financial reporting – Designed to provide in-depth accounting management tools based on standard views

of financial activities across legal entities.

The Finance and Operations mobile app empowers your organization to mobilize its business processes. After

your IT admin enables the mobile workspaces feature for your organization, users can sign in to the app and

immediately begin to run business processes from their mobile devices. The Dynamics 365 for Finance and

Operations mobile app includes the following features that can help increase productivity:

Users can view, edit, and act on business data, even if they have intermittent network connectivity or their

mobile devices are offline. When a device reestablishes a network connection, offline data operations are

automatically synchronized with Finance and Operations. 

IT admins or developers can build and publish mobile workspaces that have been tailored to their

organization. The app uses your existing code assets, so you don’t have to re-implement your validation

procedures, business logic, or security configuration. 

IT admins or developers can easily design mobile workspaces by using the point-and-click workspace

designer that is included with the Finance and Operations web client. 

IT admins or developers can optionally optimize the offline capabilities of workspaces by using the Business

logic extensibility framework. Because data continues to be processed while a device is offline, your mobile

scenarios remain rich and fluid, even if devices don’t have constant network connectivity.

Data from Finance and Operations can easily be integrated with Microsoft and non-Microsoft data sources using

Dataverse, Power Apps, and Power BI. For more information, see Data entities overview.

The Microsoft Office integration capabilities provide users with a productive environment that helps them get

the job done by using Office products. For more information, see Office integration overview.

For online courses and training, check out Dynamics 365 Finance and Operations on Microsoft Learn.

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/fin-ops-core/dev-itpro/data-entities/data-entities
https://docs.microsoft.com/en-us/learn/browse/?expanded=dynamics-365&products=dynamics-finance-operations&roles=administrator,developer
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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Additional resources
BlogsBlogs

Task guidesTask guides

VideosVideos

Country/region functionalityCountry/region functionality

Additional contentAdditional content

This topic provides a list of the help topics and other resources for the financial management features in

Microsoft Dynamics 365 Finance.

Select a feature area to learn more about it.

Accounts payable

Accounts receivable

Budgeting

Cash and bank management

Cost accounting

Expense management

Financial reporting

Fixed assets

General ledger and Financial reporting

Project management and accounting

Public sector

Microsoft Dynamics 365 blog

Financials blog

Microsoft Dynamics Operations Partner Community Blog

Additional help is available as task guides inside Finance and Operations. To access task guides, click the Help

button on any page.

Check out the how-to videos that are now available on the Microsoft Dynamics 365 YouTube Channel.

Country/region regulations affect tax setup and other areas of financial management. Refer to the Localization

and regulatory features section of our help content to learn about country/region-specific functionality.

Supply chain management functionality covers parts of the procure-to-pay process that includes requisitioning,

ordering, receiving, invoicing and paying for the goods and services your organization purchases. Refer to the

Supply Chain Management home page for information about the capabilities for managing purchases,

inventory, and manufacturing.

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/finance/index.md
https://docs.microsoft.com/en-us/dynamics365/finance/accounts-payable/accounts-payable
https://docs.microsoft.com/en-us/dynamics365/finance/accounts-receivable/accounts-receivable
https://docs.microsoft.com/en-us/dynamics365/finance/budgeting/budgeting-overview
https://docs.microsoft.com/en-us/dynamics365/finance/cash-bank-management/cash-bank-management
file:///T:/eiye/ac1a/dynamics365/finance/expense-management/expense-management.html
file:///T:/eiye/ac1a/dynamics365/dev-itpro/analytics/financial-reporting-intro.html
https://docs.microsoft.com/en-us/dynamics365/finance/fixed-assets/fixed-assets
https://docs.microsoft.com/en-us/dynamics365/finance/general-ledger/general-ledger
file:///T:/eiye/ac1a/dynamics365/finance/project-management/overview-project-management-accounting.html
https://docs.microsoft.com/en-us/dynamics365/finance/public-sector/public-sector-functionality
https://community.dynamics.com/b/msftdynamicsblog?c=Enterprise
https://community.dynamics.com/365/financeandoperations/b/financials
https://community.dynamics.com/partner/b/operationspartnercommunityblog
https://www.youtube.com/channel/UCJGCg4rB3QSs8y_1FquelBQ
file:///T:/eiye/ac1a/dynamics365/dev-itpro/lcs-solutions/country-region.html
https://github.com/MicrosoftDocs/Dynamics-365-Operations/blob/WhatsNew-SCM-10-0-6/articles/supply-chain/index.md
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Core concepts and tasks

Dynamics 365 Commerce—built on the proven Dynamics 365 Retail capabilities—delivers a comprehensive

omnichannel solution that unifies back-office, in-store, call center, and digital experiences. Dynamics 365

Commerce enables you to build brand loyalty through personalized customer engagements, increase revenue

with improved employee productivity, optimize operations to reduce costs and drive supply chain efficiencies,

ultimately delivering better business outcomes.

This release enables the creation of digital experiences using built-in web authoring and development tools to

produce engaging and intelligent digital storefronts. A connected marketing and headless commerce platform

further enable the seamless management of content, assets, promotions, inventory, and pricing across all

channels.

Ever ything to build and run digital commerce:Ever ything to build and run digital commerce: Streamline your business and end-to-end

commerce solution that scales to your needs across traditional and emerging channels. Built-in web

authoring and development tools enable you to create engaging intelligent digital storefronts, while a

connected marketing and headless commerce platform enables seamless management of content, assets,

promotions, inventory, and pricing across channels.

Build loyalty and exceed customer expectations:Build loyalty and exceed customer expectations: Use clienteling tools to gain a comprehensive view

of your customer and respond to their needs at every level of engagement, based on customer profile,

history, and preferences that flow across physical and digital channels. Empower your employees to

foster lasting relationships through AI-driven recommendations, customer insights, and loyalty programs

that elevate brand appeal.

Flexible and intelligent omnichannel experience:Flexible and intelligent omnichannel experience: Unify physical and digital commerce by providing

consistent experiences to customers across cloud search and discovery, product reviews, wish lists,

inventory, gift cards, and loyalty. Allow customers to purchase when, how, and where they want, on any

device—while providing choice around modern payment methods and product collection or delivery.

Streamline operations using AI in the cloud:Streamline operations using AI in the cloud: Drive omnichannel commerce experiences and

integrated, optimized back-office operations through ingrained, pervasive, and context-aware cloud

intelligence. Use advanced merchandising, inventory management, distributed order management, and

pricing and promotion to innovate and stay ahead of competition.Derive insights by visualizing and

analyzing comprehensive and consistent data across all aspects of your business. Use AI-driven

technologies to provide accessible websites, protect your business against payment fraud, and efficiently

moderate user-generated content like ratings and reviews.

Select a feature area to learn more about it.

Configure a Commerce preview environment

Commerce architecture

Set up your channels

Merchandising your products and services

Manage your orders

Manage your customers

Manage your financials

https://github.com/MicrosoftDocs/Dynamics-365-Unified-Operations-Public/blob/live/articles/commerce/index.md
https://docs.microsoft.com/en-us/dynamics365/commerce/provisioning-guide
file:///T:/eiye/ac1a/dynamics365/commerce/retail-components.html
https://docs.microsoft.com/en-us/dynamics365/commerce/channels-overview
https://docs.microsoft.com/en-us/dynamics365/commerce/set-up-retail-products
https://docs.microsoft.com/en-us/dynamics365/commerce/order-fulfillment-overview
https://docs.microsoft.com/en-us/dynamics365/commerce/set-up-customer-loyalty-program
https://docs.microsoft.com/en-us/dynamics365/commerce/retail-statements
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Manage your e-Commerce site

Fraud protection

Commerce development and extensibility

Can you tell us about your documentation language preferences? Take a short survey.

The survey will take about seven minutes. No personal data is collected (privacy statement).

https://docs.microsoft.com/en-us/dynamics365/commerce/online-store-overview
https://docs.microsoft.com/en-us/dynamics365/commerce/dev-itpro/dfp
https://docs.microsoft.com/en-us/dynamics365/commerce/dev-itpro/dev-retail-home-page
https://aka.ms/BAG_Docs_Language_Survey
https://go.microsoft.com/fwlink/?LinkId=521839
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